Chapter 1. Introduction

Introduction .................................................................................................................. 2
Carlson Directory Structure ......................................................................................... 2
Installation Guide ......................................................................................................... 3
Starting AutoCAD with Carlson .................................................................................. 9
License Models ............................................................................................................. 9
Carlson Registration ..................................................................................................... 11
Tablet Template .......................................................................................................... 12
Troubleshooting Setup ................................................................................................. 13
Loading Carlson Menus ............................................................................................... 14
Obtaining Technical Support ...................................................................................... 15
Command Entry .......................................................................................................... 16
Transparent Commands ............................................................................................... 16
What is New .................................................................................................................. 18
Setting Up a Project ..................................................................................................... 21
New/Startup Wizard ..................................................................................................... 22
Layer and Style Defaults .............................................................................................. 24
Carlson File Types ....................................................................................................... 25
File Selector ................................................................................................................ 28
Standard Report Viewer .............................................................................................. 31
Report Formatter Dialog ............................................................................................. 33
Instruction Manual and Program Conventions ............................................................ 41
Language Localization ................................................................................................. 42
Patch Management ....................................................................................................... 46
License Management .................................................................................................... 48

Chapter 2. General Commands

File Menu ....................................................................................................................... 54
New ................................................................................................................................. 54
Drawing Cleanup .......................................................................................................... 56
Drawing Explorer ......................................................................................................... 59
Project Explorer ........................................................................................................... 62
Get Project from Data Depot ....................................................................................... 70
Layout Manager ........................................................................................................... 72
Import LandXML File ................................................................................................... 74
Contents
Edit Points .............................................................. 291
Erase Points .............................................................. 292
Freeze Points .............................................................. 292
Thaw Points .............................................................. 293
Translate Points ............................................................ 293
Rotate Points .............................................................. 295
Align Points ............................................................... 297
Scale Points ............................................................... 298
Move Points .............................................................. 300
Edit Point Attributes .................................................... 301
Edit Multiple Pt Attributes ............................................. 302
Move Point Attributes Single ........................................... 305
Move Point Attributes with Leader .................................... 305
Scale Point Attributes ................................................... 306
Erase Point Attributes ................................................... 307
Twist Point Attributes ................................................... 307
Resize Point Attributes ................................................ 308
Fix Point Attribute Overlaps .......................................... 308
Trim by Point Symbol .................................................. 311
Change Point LayerColor .............................................. 311
Renumber Points ......................................................... 312
Explode Carlson Points ................................................ 313
Convert Surveyor1 to CRD ............................................. 313
Convert CRD to TDS CR5(Convert TDS CR5 to CRD) .............. 313
Convert CRD to Land Desktop MDB ................................ 314
Convert Land Desktop MDB to Carlson Points ..................... 314
Convert Civil 3D to Carlson Points .................................. 315
Convert Carlson Points to Land Desktop ......................... 315
Convert Land Desktop to Carlson Points ......................... 315
Convert Softdesk to Carlson Points ................................ 316
Convert Carlson Points to C&G ...................................... 316
Convert C&G to Carlson Points ..................................... 316
Convert Carlson Points to Simplicity ................................ 317
Convert Simplicity to Carlson Points ............................... 317
Convert Leica to Carlson Points ..................................... 318
Convert Geodimeter to Carlson Points ............................. 318
Convert Carlson Points to Ashtech GIS ............................ 318
Convert Carlson Points to Softdesk ................................ 318
Chapter 3. Survey Module

Survey Menu

Data Collectors

Edit-Process Raw Data File

Edit-Process Level Data

Edit Process SDMS File

SurvNET

Introduction

Starting Survnet

Menu System Overview

File Menu

Settings Menu

Process Menu

Tools Menu

View Menu

Toolbars

Raw Traverse Data

SurvNET Editor

Data Collector Transfer

Example Projects

Network Processing Reports

2D-1D Local Coordinate System

2D-1D State Plane Coordinate System

GPS Network

GPS Vectors and Total Station

Vertical Adjustment

Draw Field to Finish

Field to Finish Inspector

Enter Deed Description

Deed Reader
Contents

Numeric Pad COGO ............................................................... 592
Point on Arc ........................................................................... 593
Divide Between Points ............................................................ 594
Divide Along Entity ................................................................. 594
Interval Between Points .......................................................... 595
Interval Along Entity ............................................................... 595
Line by Angle-Distance ........................................................... 597
Tangent Line from Circles ......................................................... 597
Building Offset Extensions ....................................................... 598
Radial Stakeout ....................................................................... 599
Section Subdivision ................................................................ 601
GLO Corner Proportioning ....................................................... 601
One Way Control .................................................................... 602
Two Way Control .................................................................... 603
Three Way Control .................................................................. 604
Four Way Control ................................................................... 606
Geodetic Single Proportion Line Division ................................. 607
Geodetic Double Break ............................................................ 607
Geodetic Middle Break ............................................................. 608
Solar Observations ................................................................. 608
Triangle Solutions .................................................................. 611
Best Fit Point .......................................................................... 612
Best Fit Circle .......................................................................... 613
Best Fit Centerline ................................................................... 614
Best Fit Line by Average .......................................................... 615
Best Fit Line by Least Squares .................................................. 616
Area/Layout Menu .................................................................... 617
Area Defaults .......................................................................... 618
Inverse with Area .................................................................... 623
Area by Lines & Arcs ................................................................. 624
Area by Interior Point ............................................................... 625
Area by Closed Polylines .......................................................... 625
Digitize Areas .......................................................................... 627
Label Last Area ....................................................................... 627
Area Table Defaults ................................................................. 628
New Area Table ....................................................................... 631
Set Active Area Table .............................................................. 631
Edit Area Table Properties ....................................................... 631
Contents
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset Dimensions</td>
<td>724</td>
</tr>
<tr>
<td>Building Dimensions</td>
<td>725</td>
</tr>
<tr>
<td>Adjoiner Text</td>
<td>726</td>
</tr>
<tr>
<td>Draw Grid</td>
<td>726</td>
</tr>
<tr>
<td>Stack Label Arc</td>
<td>728</td>
</tr>
<tr>
<td>Draw Legend</td>
<td>730</td>
</tr>
<tr>
<td>Draw North Arrow</td>
<td>732</td>
</tr>
<tr>
<td>Draw Barscale</td>
<td>733</td>
</tr>
<tr>
<td>Create Point Table</td>
<td>734</td>
</tr>
<tr>
<td>Update Point Table</td>
<td>735</td>
</tr>
<tr>
<td>Table Defaults</td>
<td>735</td>
</tr>
<tr>
<td>Table Header</td>
<td>738</td>
</tr>
<tr>
<td>Set Table Position</td>
<td>739</td>
</tr>
<tr>
<td>Curve Table</td>
<td>739</td>
</tr>
<tr>
<td>Line Table</td>
<td>739</td>
</tr>
<tr>
<td>Railroad Curve Table</td>
<td>740</td>
</tr>
<tr>
<td>Edit Table Properties</td>
<td>740</td>
</tr>
<tr>
<td>Edit Table Values</td>
<td>744</td>
</tr>
<tr>
<td>Split Table</td>
<td>745</td>
</tr>
<tr>
<td>Merge Tables</td>
<td>746</td>
</tr>
<tr>
<td>Delete Table Elements</td>
<td>747</td>
</tr>
<tr>
<td>Label Arc</td>
<td>747</td>
</tr>
<tr>
<td>Custom Label Formatter</td>
<td>749</td>
</tr>
<tr>
<td>Draw Text On Arc</td>
<td>750</td>
</tr>
<tr>
<td>Draw Text on Tangent</td>
<td>752</td>
</tr>
<tr>
<td>Edit Text on Arc or Tangent</td>
<td>753</td>
</tr>
<tr>
<td>Fit Text Inside Arc</td>
<td>753</td>
</tr>
<tr>
<td>Fit Text Outside Arc</td>
<td>753</td>
</tr>
<tr>
<td>Change Polyline Linetype</td>
<td>753</td>
</tr>
<tr>
<td>Polyline to Special Line</td>
<td>755</td>
</tr>
<tr>
<td>Polyline to Tree Line</td>
<td>756</td>
</tr>
<tr>
<td>Add Zig to Polyline</td>
<td>757</td>
</tr>
<tr>
<td>Add Culvert to Polyline</td>
<td>757</td>
</tr>
<tr>
<td>Sketch Tree Line</td>
<td>757</td>
</tr>
<tr>
<td>Special Line/Entity</td>
<td>758</td>
</tr>
<tr>
<td>Guard Rail</td>
<td>758</td>
</tr>
<tr>
<td>Label Angle</td>
<td>759</td>
</tr>
<tr>
<td>Label Coordinates/Elevation</td>
<td>759</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Chapter 4.  CGSurvey Module</td>
<td>766</td>
</tr>
<tr>
<td>CGFile</td>
<td>767</td>
</tr>
<tr>
<td>Current Information</td>
<td>767</td>
</tr>
<tr>
<td>Coordinate Files</td>
<td>768</td>
</tr>
<tr>
<td>Opening Closing and Saving</td>
<td>768</td>
</tr>
<tr>
<td>New</td>
<td>768</td>
</tr>
<tr>
<td>Open</td>
<td>769</td>
</tr>
<tr>
<td>Close</td>
<td>770</td>
</tr>
<tr>
<td>Save As</td>
<td>770</td>
</tr>
<tr>
<td>Export Coordinates to ASCII</td>
<td>771</td>
</tr>
<tr>
<td>Import ASCII File into Coordinates</td>
<td>782</td>
</tr>
<tr>
<td>Close Raw File</td>
<td>783</td>
</tr>
<tr>
<td>Close Map Check File</td>
<td>783</td>
</tr>
<tr>
<td>CGDos Drawings</td>
<td>783</td>
</tr>
<tr>
<td>Open Dos Drawing</td>
<td>784</td>
</tr>
<tr>
<td>Setup DOS Dwg</td>
<td>785</td>
</tr>
<tr>
<td>Convert Old CG Dos Level File to New Format</td>
<td>786</td>
</tr>
<tr>
<td>Convert Old CG Dos Raw File to New format</td>
<td>786</td>
</tr>
<tr>
<td>Convert Old CG Dos Cross Section File to New Format</td>
<td>786</td>
</tr>
<tr>
<td>Convert Old CG Dos Template File to New Format</td>
<td>787</td>
</tr>
<tr>
<td>Empty Print File</td>
<td>787</td>
</tr>
<tr>
<td>Print View Print File</td>
<td>787</td>
</tr>
<tr>
<td>CGTrav</td>
<td>788</td>
</tr>
<tr>
<td>Quick Traverse</td>
<td>788</td>
</tr>
<tr>
<td>Edit Raw File</td>
<td>791</td>
</tr>
<tr>
<td>Data Collector Transfer</td>
<td>792</td>
</tr>
<tr>
<td>Reduce Traverse</td>
<td>845</td>
</tr>
<tr>
<td>Edit Map Check File</td>
<td>859</td>
</tr>
<tr>
<td>Reduce Map Check File</td>
<td>859</td>
</tr>
<tr>
<td>Visual Map Check</td>
<td>861</td>
</tr>
<tr>
<td>Create StarNet File</td>
<td>863</td>
</tr>
<tr>
<td>CGCogo</td>
<td>866</td>
</tr>
<tr>
<td>General Information</td>
<td>866</td>
</tr>
</tbody>
</table>
Contents

Border .................................................. 904
Coordinate Grid ....................................... 905
Text on Arc ........................................... 907
Create .................................................. 907
Move ..................................................... 907
Edit ....................................................... 907
Delete ................................................... 908

Draw Mapcheck ........................................ 909
Multi-Draw ............................................ 911
Plot Points and Symbols ............................. 914
Plot Points on Screen ................................ 914
Remove Points from Screen ...................... 915

Graphic Scale ......................................... 915
Lines and Polylines .................................. 916
Lines by Point Number ............................... 916
Lines by Description .................................. 917
Lines by Codes ......................................... 918
Polylines by Point ..................................... 918
Fit Polylines ........................................... 919
Calls ....................................................... 921
Place Calls ............................................. 921
Move Calls .............................................. 923
Reverse Calls .......................................... 923

Tables ..................................................... 923
Coordinates ............................................ 923
Call Table ............................................... 925
Curve ..................................................... 927
Auto Map ................................................ 928
Draw ....................................................... 928
Erase ...................................................... 934
Leaders ................................................... 934
Text ........................................................ 934
Coordinate Leader ..................................... 935
Point Label .............................................. 936
Station-Offset ......................................... 936
Query ..................................................... 937
Drop C&G Attributes ................................. 938
re-Associate Coord. file ............................ 938

xvii
Chapter 5. Construction Module 1045

Overview 1046

Chapter 6. Civil Module 1047

3D Data Menu 1048

Change Elevations 1048

Set Polyline To Elevation 1048

Edit-Assgin Polyline Elevations 1049

Edit-Assgin Wall Polyline Profiles 1051

2D to 3D Polyline by Surface Model 1052

2D to 3D Polyline by Screen Entities 1052

2D to 3D Polyline by Points 1053

2D to 3D Polyline by Text 1053

2D to 3D Polyline by Text With Leader 1054
Highlight Segments by Slope .......................................................... 1096
Highlight Crossing Breaklines ....................................................... 1097
Report 3D Polyline Station/Elevation .............................................. 1098
Story Stake from Surface Entities .................................................. 1099
Story Stake By Points/Polyline ...................................................... 1100
Tag Non-Surface Points .............................................................. 1102
Untag Non-Surface Points ........................................................... 1103
Report Non-Surface Points ........................................................... 1104
Non-Surface Entities .................................................................... 1105
Tag Hard Breakline Polylines ........................................................ 1106
Highlight Hard Breakline Polylines ................................................. 1106
Identify Hard Breakline Polylines ................................................... 1106
Untag Hard Breakline Polylines ...................................................... 1107
Surface Menu .............................................................................. 1107
Tag Predefined Boundaries .......................................................... 1107
Identify Predefined Boundaries ...................................................... 1107
Untag Predefined Boundaries ....................................................... 1108
Triangulate & Contour ................................................................. 1108
Triangulation File Utilities ............................................................ 1122
Surface Manager ....................................................................... 1126
Contour from Triangular Mesh ....................................................... 1133
Contours from Grid File ............................................................... 1134
Contour from TIN File ................................................................. 1137
Contour From Section File ............................................................ 1138
Smooth Contours ....................................................................... 1139
Reduce Contour Vertices .............................................................. 1141
Edit Contours ............................................................................ 1142
Contour ID .................................................................................. 1143
Color Contours by Elevation ......................................................... 1143
Color Contours by Interval .......................................................... 1145
Highlight Index Contours .............................................................. 1146
Highlight Depression Contours .................................................... 1146
Draw Contour Gradient Marks ....................................................... 1147
Change Contour-Plines Width ....................................................... 1148
Trim Contour-Plines by Pline ......................................................... 1148
Contour Elevation Label .............................................................. 1149
Local Elevation Label .................................................................. 1151
Move Label Along Contour .......................................................... 1151
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation Zone Analysis</td>
<td>1233</td>
</tr>
<tr>
<td>Slope Report</td>
<td>1235</td>
</tr>
<tr>
<td>Slope At Points</td>
<td>1237</td>
</tr>
<tr>
<td>Slope Zone Analysis</td>
<td>1239</td>
</tr>
<tr>
<td>Slope Direction Analysis</td>
<td>1243</td>
</tr>
<tr>
<td>Convert LDD Contours</td>
<td>1245</td>
</tr>
<tr>
<td>Convert LDT/Civil3D Surface Drawing</td>
<td>1246</td>
</tr>
<tr>
<td>Import Google Earth Surface</td>
<td>1246</td>
</tr>
<tr>
<td>Import/Export Trimble TTM File</td>
<td>1249</td>
</tr>
<tr>
<td>Export Topcon TIN File</td>
<td>1249</td>
</tr>
<tr>
<td>SiteNet Menu</td>
<td>1250</td>
</tr>
<tr>
<td>Centerline Menu</td>
<td>1250</td>
</tr>
<tr>
<td>Design Centerline</td>
<td>1250</td>
</tr>
<tr>
<td>Input-Edit Centerline File</td>
<td>1253</td>
</tr>
<tr>
<td>Polyline to Centerline File</td>
<td>1261</td>
</tr>
<tr>
<td>Edit Centerline On-Screen</td>
<td>1262</td>
</tr>
<tr>
<td>Draw Centerline File</td>
<td>1263</td>
</tr>
<tr>
<td>Centerline Report</td>
<td>1263</td>
</tr>
<tr>
<td>Centerline ID</td>
<td>1264</td>
</tr>
<tr>
<td>Station Polyline/Centerline</td>
<td>1265</td>
</tr>
<tr>
<td>Label Station-Offset</td>
<td>1272</td>
</tr>
<tr>
<td>Offset Point Entry</td>
<td>1276</td>
</tr>
<tr>
<td>Calculate Offsets</td>
<td>1278</td>
</tr>
<tr>
<td>Distance Between Two Entities</td>
<td>1280</td>
</tr>
<tr>
<td>Centerline Conversions</td>
<td>1281</td>
</tr>
<tr>
<td>Enter Right of Way</td>
<td>1281</td>
</tr>
<tr>
<td>Polyline to Right of Way</td>
<td>1282</td>
</tr>
<tr>
<td>Label/Draw Right of Way</td>
<td>1283</td>
</tr>
<tr>
<td>Horizontal Speed Table</td>
<td>1283</td>
</tr>
<tr>
<td>Profile Menu</td>
<td>1285</td>
</tr>
<tr>
<td>Quick Profile</td>
<td>1286</td>
</tr>
<tr>
<td>Profile from Surface Entities</td>
<td>1288</td>
</tr>
<tr>
<td>Profile from Grid or Triangulation Surface</td>
<td>1289</td>
</tr>
<tr>
<td>Profile from 3D Polyline</td>
<td>1290</td>
</tr>
<tr>
<td>Profile from 3D Points</td>
<td>1291</td>
</tr>
<tr>
<td>Profile from Section File</td>
<td>1292</td>
</tr>
<tr>
<td>Profile from Points on Centerline</td>
<td>1293</td>
</tr>
<tr>
<td>Profile from Polyline on Profile Grid</td>
<td>1293</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Profile from Layers</td>
<td>1294</td>
</tr>
<tr>
<td>Profile from Pipe Polylines</td>
<td>1295</td>
</tr>
<tr>
<td>Enter Profile On-Screen</td>
<td>1296</td>
</tr>
<tr>
<td>Input-Edit Road Profile</td>
<td>1297</td>
</tr>
<tr>
<td>Design Road Profile</td>
<td>1302</td>
</tr>
<tr>
<td>Design Sewer/Pipe Profile</td>
<td>1305</td>
</tr>
<tr>
<td>Input-Edit Profile File</td>
<td>1312</td>
</tr>
<tr>
<td>Draw Profile</td>
<td>1315</td>
</tr>
<tr>
<td>Draw Profile Grid</td>
<td>1342</td>
</tr>
<tr>
<td>Add Grid Ticks and Dots</td>
<td>1344</td>
</tr>
<tr>
<td>Add Grid Lines</td>
<td>1345</td>
</tr>
<tr>
<td>Adjust Profile Grid</td>
<td>1345</td>
</tr>
<tr>
<td>Adjust Draw Profile Settings</td>
<td>1346</td>
</tr>
<tr>
<td>Adjust Plan/Profile Sheet</td>
<td>1346</td>
</tr>
<tr>
<td>Move Sewer Profile Labels</td>
<td>1347</td>
</tr>
<tr>
<td>Draw Plan View Sheets</td>
<td>1348</td>
</tr>
<tr>
<td>Horizontal Axis Elevations</td>
<td>1351</td>
</tr>
<tr>
<td>Horizontal Axis Crossings</td>
<td>1352</td>
</tr>
<tr>
<td>Profile to 3D Polyline</td>
<td>1354</td>
</tr>
<tr>
<td>Profile To Points</td>
<td>1355</td>
</tr>
<tr>
<td>Profile Report</td>
<td>1357</td>
</tr>
<tr>
<td>Polyline Slope Report</td>
<td>1359</td>
</tr>
<tr>
<td>Station-Elevation-Slope Report</td>
<td>1360</td>
</tr>
<tr>
<td>Sag &amp; Crest Report</td>
<td>1362</td>
</tr>
<tr>
<td>Pipe Depth Summary</td>
<td>1363</td>
</tr>
<tr>
<td>Label Profile On Centerline</td>
<td>1365</td>
</tr>
<tr>
<td>Profile ID</td>
<td>1369</td>
</tr>
<tr>
<td>Review Profile Links</td>
<td>1370</td>
</tr>
<tr>
<td>Input - Edit Trench Template</td>
<td>1370</td>
</tr>
<tr>
<td>Draw Typical Trench Template</td>
<td>1371</td>
</tr>
<tr>
<td>Point Placement on Profile</td>
<td>1372</td>
</tr>
<tr>
<td>Draw Single Manhole</td>
<td>1374</td>
</tr>
<tr>
<td>Best Fit Profile</td>
<td>1375</td>
</tr>
<tr>
<td>Merge Profiles</td>
<td>1376</td>
</tr>
<tr>
<td>Average Profiles</td>
<td>1376</td>
</tr>
<tr>
<td>Draw Pipe 3D Polyline</td>
<td>1377</td>
</tr>
<tr>
<td>Assign Pipe Width to Polyline</td>
<td>1377</td>
</tr>
<tr>
<td>Profile Offset Text</td>
<td>1378</td>
</tr>
</tbody>
</table>
Contents

Mass Diagram Report ....................................................... 1438
Mass Haul Report .......................................................... 1439
Mass Haul Analysis ......................................................... 1439
Cut/Fill Width Analysis ..................................................... 1442
Cut Sheet ........................................................................ 1443
Design Regrade ............................................................... 1444
Calculate Haul Factors ...................................................... 1446
Sections to 3D Polylines ..................................................... 1447
Sections to Points ............................................................. 1448
Design Section Staging ...................................................... 1449
Draw Pipe 3D Polyline ....................................................... 1451
Assign Pipe Width to Polyline ........................................... 1451
Slope Stake Report ............................................................ 1451
Extend Sections to Offset Limits ........................................ 1454
Slope Zone Section Analysis .............................................. 1454
Regrade Fill Slope ............................................................. 1455
Overlay Section File .......................................................... 1455
Average Section Files ........................................................ 1456
Merge Sections ................................................................. 1457
Compare Section Files ....................................................... 1457
Move Section Leader Labels .............................................. 1458
Update Sections from Polylines ......................................... 1458
Review Section Links ........................................................ 1458
Section ID ........................................................................ 1459
Calculate Section Volumes ............................................... 1459
Calculate End Area ............................................................ 1462
Edit Process End Area File ............................................... 1463
Roads Menu ..................................................................... 1464
Design Template ............................................................... 1464
Draw Typical Template ...................................................... 1475
Template Transition .......................................................... 1477
Template Grade Table ........................................................ 1480
Input-Edit Super Elevation ................................................. 1482
Draw Super Elevation Diagram ......................................... 1486
Input-Edit Template Series ............................................... 1491
Topsoil Removal/Replacement .......................................... 1493
Assign Template Point Profile .......................................... 1495
Assign Template Point Centerline ...................................... 1496
Chapter 7. Hydrology Module

Surface Menu
Overview
Universal Soil Loss

Watershed Menu
Define Watershed Layers
Watershed Analysis
Run Off Tracking
3D Polyline Flow Values
Rainfall Frequency and Amount
Sub-Watersheds By Land Use
Curve Numbers & Runoff
Calculate C-Factor
Time of Concentration - SCS Method
Time of Concentration - TR-55 Method
Time of Concentration - Rational Method
Time of Concentration - Kirpich Method
Peak Flow - Graphical Method
Peak Flow - Tabular Hydrograph Method
Peak Flow - Rational Method (General)
Peak Flow - Rational Method (Riverside S. California)
Peak Flow - Rational Method (KYDOT)
Watershed Settings (Save and Load)
Runoff Hydrograph - SCS Method
Runoff Hydrograph - TR-55 Tabular Method
Runoff Hydrograph - Rational Method
Pipe Routing Hydrograph
Reservoir Routing Hydrograph
Channel Routing Hydrograph - Convex Method
Channel Routing Hydrograph - Modified Att-Kin Method .................................. 1661
Draw Flow Polylines TR20 .................................................................................. 1664
Locate Structures TR20 ...................................................................................... 1665
Locate Reach ........................................................................................................ 1666
Edit Layout Element ............................................................................................. 1666
Hydrograph Development ..................................................................................... 1667
Single Runoff Hydrograph .................................................................................... 1669
Add Hydrographs .................................................................................................. 1670
Report Hydrograph ............................................................................................... 1670
Draw Hydrograph .................................................................................................. 1671
SEDCAD Draw Flow Polylines ............................................................................ 1673
SEDCAD Locate Structures ................................................................................... 1673
SEDCAD Label Structure Layout ......................................................................... 1673
SEDCAD Prepare HEC-RAS Input File ................................................................. 1674
Draw Hec-Ras Watermark ..................................................................................... 1678
Import Flow Velocity Points .................................................................................. 1679
Import Flow Depth Points ..................................................................................... 1681
HEC2 Programs ...................................................................................................... 1683
Prepare HEC2 Input File ....................................................................................... 1683
Draw Watermark .................................................................................................... 1685
Structure Menu ....................................................................................................... 1686
Detention Pond Sizing ............................................................................................ 1686
Detention Pond Sizing - Linear Storage Estimate Method .................................... 1687
Rectangular Pond Design ....................................................................................... 1688
Design Spillway ......................................................................................................... 1690
Drop Pipe Spillway Design .................................................................................... 1691
Rectangular Weir Design ....................................................................................... 1693
Advanced Weir Design ........................................................................................ 1694
Orifice Design .......................................................................................................... 1697
Pond Exfiltration Design ........................................................................................ 1699
Multiple Outlet Design .......................................................................................... 1701
Input-Edit Stage-Storage ....................................................................................... 1703
Calculate Stage-Storage ........................................................................................ 1707
Draw Stage-Storage Curve ..................................................................................... 1709
Input-Edit Stage-Discharge .................................................................................... 1712
Draw Stage-Discharge Graph ............................................................................... 1714
Report Stage-Discharge .......................................................................................... 1715
Chapter 8. GIS Module

GIS Data Menu

Carlson GIS and Esri

GIS Database Settings

Define Template Database

Input-Edit GIS Data

GIS Inspector

GIS Inspector Settings

GIS Query/Report

Hatch GIS Polylines

Mark GIS Polylines

Data Capture Text By Sample

Data Capture Enclosed Text

Data Capture Block Attributes

Data Capture Add Point Data to Linework
Contents

Make User Defined Surface .................................................. 1933
Triangulate and Contour ..................................................... 1934
Triangulation File Utilities .................................................. 1944
Volumes By Triangulation ..................................................... 1947
Calculate Stockpile Volume .................................................. 1948
Calculate Pond/Pit Volume .................................................... 1949
Set Active Surfaces ............................................................ 1950
Design Surface Vertical Offset .............................................. 1951
Existing Surface Vertical Offset ............................................. 1951
Merge Existing With Design ................................................ 1951
Calculate Total Volumes ...................................................... 1951
Calculate Volumes Inside Perimeter ...................................... 1956
Draw 3DPoly Perimeter ....................................................... 1956
Draw 3DPoly Base Breakline ............................................... 1957
Material Quantities ............................................................ 1957

Tools Menu ........................................................................... 1963
3D Drive Simulation ............................................................. 1963
Existing Surface 3D Viewer .................................................. 1964
Design Surface 3D Viewer .................................................... 1966
FlyOver Along 3D Polyline .................................................... 1967
Surface Inspector .............................................................. 1968
Surface Report ................................................................. 1968
Graphic Reports ............................................................... 1969
Quick Profile ......................................................................... 1974
Cut/Fill Centroids ............................................................... 1975
Cut/Fill Map Legend ............................................................. 1977
Draw Surface As Grid ........................................................... 1977
Perimeter Polylines Properties .............................................. 1978
Update Colors For Set Elevations ......................................... 1979
Convert LDD-AEC Contours .................................................. 1979
Export Polyline File ............................................................. 1979
Import MicroStation DGN ...................................................... 1980
Import PDF File ..................................................................... 1981
Import Raster To Vector ....................................................... 1983
Import/Export Carlson Triangulation Files ............................. 1984
Convert Polylines To Text ..................................................... 1984
Convert Dashes To Polylines ................................................. 1986

Elevate Menu ........................................................................ 1987
| Contents |
|---------------------------------------------|--------|
| **Digitize End Areas**                      | 2021   |
| **Raster Menu**                             | 2023   |
| **Draw Raster Image**                       | 2023   |
| **Set Raster Image**                        | 2024   |
| **Raster Edit Options**                     | 2025   |
| **Clear Strata Surface**                    | 2026   |
| **Clear Strata Surface**                    | 2026   |
| **Raster Nearest Snap**                     | 2028   |
| **Raster EndPoint Snap**                    | 2028   |
| **Merge Raster Files**                      | 2028   |
| **Cut Image**                               | 2029   |
| **Crop Image**                              | 2029   |
| **Remove Speckles**                         | 2029   |
| **Undo Raster Edit**                        | 2030   |
| **Drillhole Menu**                          | 2030   |
| **Drillhole Strata Settings**               | 2030   |
| **Drillhole Import**                        | 2032   |
| **Place Drillhole**                         | 2034   |
| **Edit Drillhole**                          | 2036   |
| **Label Drillhole**                         | 2037   |
| **Strata Polylines**                        | 2038   |
| **Drillhole Reports**                       | 2040   |
| **Make Strata Surface**                     | 2041   |
| **Clear Strata Surface**                    | 2041   |
| **Draw Strata Cut Depth Contours**          | 2042   |
| **Erase Strata Cut Depth Contours**         | 2042   |
| **Draw Strata Cut Color Map**               | 2042   |
| **Erase Strata Cut Color Map**              | 2043   |
| **Draw Strata Surface**                     | 2043   |
| **Erase Strata Surface**                    | 2043   |
| **Trench Menu**                             | 2043   |
| **Input Trench From Polyline**              | 2043   |
| **Create Trench Network Structure**         | 2045   |
| **Edit Trench Network Structure**           | 2047   |
| **Trench Spreadsheet Editor**               | 2047   |
| **Remove Trench Network Structure**         | 2048   |
| **Find Trench Network Structure**           | 2049   |
| **Export Trench Network Data**              | 2049   |
Chapter 10. Field Module

Trench Network File Backup & Plain View Label Settings
Draw Trench Network - Plan & Draw Trench Network Centerline
Draw Trench Network - Profile & Define Pipe Groups
Input-Edit Trench Template
Draw Typical Trench Template & Trench Subgrade Areas
Trench Network Quantities & Report Trench Network

Roads Menu
Roads Pull Down & Sections From Polylines On Section Grids

Display Menu
Existing Drawing & Existing Contours
Existing Surface & Design Drawing
Design Contours & Design Surface
Cut/Fill Contours & Cut/Fill Labels
Cut/Fill Color Map & Other Drawing
Display Options

Chapter 10. Field Module

Trench Network File Backup & Plain View Label Settings
Draw Trench Network - Plan & Draw Trench Network Centerline
Draw Trench Network - Profile & Define Pipe Groups
Input-Edit Trench Template
Draw Typical Trench Template & Trench Subgrade Areas
Trench Network Quantities & Report Trench Network

Roads Menu
Roads Pull Down & Sections From Polylines On Section Grids

Display Menu
Existing Drawing & Existing Contours
Existing Surface & Design Drawing
Design Contours & Design Surface
Cut/Fill Contours & Cut/Fill Labels
Cut/Fill Color Map & Other Drawing
Display Options

Chapter 10. Field Module

COGO Menu
Tape Baseline & Cutsheet Spreadsheet Editor

Field Menu
Configure Field & Equipment Setup
Align GPS To Local Coordinates & Point Store
StakeOut & Auto Points at Interval
Track Position
Chapter 11. Point Clouds Module 2180

- Point Clouds Getting Started 2181
- Point Clouds Project Manager 2181
  - Project Tab 2182
  - Scenes 2183
  - Point Cloud Viewer 2187
  - Project Settings 2189
  - Action Tab 2193
  - Create Point 2197
  - Create Polyline 2202
  - Create Text 2206
  - Create Grid 2208
  - Image Drape 2209
  - Extract Contours 2210
  - Extract Sections 2211
  - Extract Profile 2212
  - Extract Breaklines 2213
  - Bare Earth 2216
- Scene Tab 2217
- Camera Tab 2220
- Data Tab 2223
- Data Objects 2224
  - Instrument Data Project Items 2229
  - Target Points 2232
- Cloud Objects 2239
- Processed Data Project Items 2242
- Scans 2244
- Meshes 2249
- Coordinate Points 2252
- Common Utilities 2258
  - Layer Properties Manager 2258
  - Polyline Editor 2259
  - Control Point Editor 2262
  - Point Editor 2268
  - Item Properties 2274
- Increasing Available Memory 2274
Chapter 12. Natural Regrade Module

Introduction and Overview

Problems Addressed by Natural Regrade with GeoFluv

The Fluvial Geomorphic Solution

Description of Software

Links with Other Software

Software Compatibility

Data Entry

Summary

Documentation References

Natural Regrade Menu

Design GeoFluv Regrade

Natural Regrade File

Natural Regrade Global Settings

Setup Tab

Select GeoFluv Boundary

Select Main Channel

Data for Main Channel

Pre-disturbed Surface

Channels Tab

Channel Add

Channel Delete

Channel Name

Channel Transition

Current Channel

Current Channel Settings

Data for Current Channel

Profile

Report

Output Tab

Preview

Data for GeoFluv Work Area

Draw Design Surface

Save Design Surface

Update Cut/Fill

Summary Report

DWG Tab
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw GeoFluv Contours</td>
<td>2329</td>
</tr>
<tr>
<td>3D GeoFluv Contour Viewer</td>
<td>2331</td>
</tr>
<tr>
<td>3D GeoFluv Surface Viewer</td>
<td>2333</td>
</tr>
<tr>
<td>Calculate GeoFluv Volume</td>
<td>2334</td>
</tr>
<tr>
<td>Cut/Fill Centroids</td>
<td>2334</td>
</tr>
<tr>
<td>GeoFluv Channel Cross-Section Report</td>
<td>2337</td>
</tr>
<tr>
<td>GeoFluv Channel Inspector</td>
<td>2338</td>
</tr>
<tr>
<td>View Longitudinal Profile</td>
<td>2339</td>
</tr>
<tr>
<td>Edit Longitudinal Profile</td>
<td>2340</td>
</tr>
<tr>
<td>Auto Longitudinal Profile</td>
<td>2342</td>
</tr>
<tr>
<td>RIVERMorph tab</td>
<td>2343</td>
</tr>
<tr>
<td>Settings</td>
<td>2345</td>
</tr>
<tr>
<td>Rered Valley Bottoms</td>
<td>2348</td>
</tr>
<tr>
<td>Create Vegetation Scene</td>
<td>2348</td>
</tr>
<tr>
<td>Chapter 13. Basic Mining Module</td>
<td>2351</td>
</tr>
<tr>
<td>Basic Mining Menus</td>
<td>2352</td>
</tr>
<tr>
<td>Chapter 14. Geology Module</td>
<td>2354</td>
</tr>
<tr>
<td>Drillhole Menu</td>
<td>2355</td>
</tr>
<tr>
<td>Define Drillhole</td>
<td>2356</td>
</tr>
<tr>
<td>Define Strata</td>
<td>2359</td>
</tr>
<tr>
<td>Define Lookup Database</td>
<td>2366</td>
</tr>
<tr>
<td>Define Geologic Order</td>
<td>2367</td>
</tr>
<tr>
<td>Define Attributes</td>
<td>2367</td>
</tr>
<tr>
<td>Define Equations</td>
<td>2368</td>
</tr>
<tr>
<td>Define Ferm Codes</td>
<td>2369</td>
</tr>
<tr>
<td>Define Horizon Codes</td>
<td>2370</td>
</tr>
<tr>
<td>Import Drillhole</td>
<td>2371</td>
</tr>
<tr>
<td>Import Qualities</td>
<td>2376</td>
</tr>
<tr>
<td>Import Bed Names</td>
<td>2377</td>
</tr>
<tr>
<td>Coal Section to Drillhole</td>
<td>2378</td>
</tr>
<tr>
<td>Reassign Database File</td>
<td>2379</td>
</tr>
<tr>
<td>Convert Drillholes to External Database/Convert Drillholes to Drawing Data</td>
<td>2379</td>
</tr>
<tr>
<td>Export Drillholes</td>
<td>2379</td>
</tr>
<tr>
<td>Drillholes to Points</td>
<td>2380</td>
</tr>
<tr>
<td>Import/Export Isatis</td>
<td>2380</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Edit Fault Line</td>
<td>2476</td>
</tr>
<tr>
<td>Calculate Fault Shift</td>
<td>2477</td>
</tr>
<tr>
<td>Report Fault Lines</td>
<td>2478</td>
</tr>
<tr>
<td>Highlight Fault Lines</td>
<td>2478</td>
</tr>
<tr>
<td>Identify Fault Polylines</td>
<td>2479</td>
</tr>
<tr>
<td>Apply Faults to Grid</td>
<td>2479</td>
</tr>
<tr>
<td>Draw Fault Surface</td>
<td>2481</td>
</tr>
<tr>
<td>Draw Heave Zones</td>
<td>2481</td>
</tr>
<tr>
<td>Create Strata Polylines at Faults</td>
<td>2483</td>
</tr>
<tr>
<td>Input-Edit Strike-Dip Symbols</td>
<td>2484</td>
</tr>
<tr>
<td>Draw Strike-Dip Symbol</td>
<td>2485</td>
</tr>
<tr>
<td>Tag Strata Polylines</td>
<td>2486</td>
</tr>
<tr>
<td>Offset Strata Polylines</td>
<td>2487</td>
</tr>
<tr>
<td>Report Strata Polylines</td>
<td>2487</td>
</tr>
<tr>
<td>Highlight Strata Polylines</td>
<td>2488</td>
</tr>
<tr>
<td>Identify Strata Polylines</td>
<td>2488</td>
</tr>
<tr>
<td>Untag Strata Polylines</td>
<td>2488</td>
</tr>
<tr>
<td>Name Limit Polylines</td>
<td>2488</td>
</tr>
<tr>
<td>Report Limit Polylines</td>
<td>2491</td>
</tr>
<tr>
<td>Highlight Limit Polylines</td>
<td>2491</td>
</tr>
<tr>
<td>Identify Limit Polylines</td>
<td>2492</td>
</tr>
<tr>
<td>UnTag Limit Polylines</td>
<td>2493</td>
</tr>
<tr>
<td>Prepare Variogram Data</td>
<td>2493</td>
</tr>
<tr>
<td>Calculate Variogram</td>
<td>2494</td>
</tr>
<tr>
<td>Surface Mine Reserves</td>
<td>2496</td>
</tr>
<tr>
<td>Define Surface Mine Auto Run</td>
<td>2503</td>
</tr>
<tr>
<td>Underground Mine Reserves</td>
<td>2504</td>
</tr>
<tr>
<td>Make 3D Grid File</td>
<td>2506</td>
</tr>
<tr>
<td>Make Top Of Key Grid</td>
<td>2507</td>
</tr>
<tr>
<td>Make Nearest Data Point Grid</td>
<td>2507</td>
</tr>
<tr>
<td>Grid Inspector</td>
<td>2509</td>
</tr>
<tr>
<td>Grid History Review</td>
<td>2510</td>
</tr>
<tr>
<td>Draw 3D Grid File</td>
<td>2512</td>
</tr>
<tr>
<td>Contour From Grid File</td>
<td>2512</td>
</tr>
<tr>
<td>One Surface Volumes</td>
<td>2512</td>
</tr>
<tr>
<td>Two Surface Volumes</td>
<td>2512</td>
</tr>
<tr>
<td>Grid File Utilities</td>
<td>2512</td>
</tr>
<tr>
<td>Merge Grid Files</td>
<td>2512</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Merge Elevation for Zero Thickness</td>
<td>2512</td>
</tr>
<tr>
<td>Cleanup Grid Area</td>
<td>2513</td>
</tr>
<tr>
<td>Reserve Classification</td>
<td>2513</td>
</tr>
<tr>
<td>Convert As Determined Qualities</td>
<td>2516</td>
</tr>
<tr>
<td>Composite Qualities Analysis</td>
<td>2516</td>
</tr>
<tr>
<td>Blending Weighted Average</td>
<td>2517</td>
</tr>
<tr>
<td>Calculate Residuals</td>
<td>2518</td>
</tr>
<tr>
<td>AutoRun Residuals</td>
<td>2521</td>
</tr>
<tr>
<td>Fence Diagram</td>
<td>2522</td>
</tr>
<tr>
<td>Quick Fence</td>
<td>2529</td>
</tr>
<tr>
<td>Fence Polylines</td>
<td>2530</td>
</tr>
<tr>
<td>Block Diagram</td>
<td>2530</td>
</tr>
<tr>
<td>Draw Voroni Diagram</td>
<td>2533</td>
</tr>
<tr>
<td>Color Elevation Grid by Strata</td>
<td>2535</td>
</tr>
<tr>
<td>Block Model Menu</td>
<td>2535</td>
</tr>
<tr>
<td>Make Block Model</td>
<td>2536</td>
</tr>
<tr>
<td>Input-Edit Block Model</td>
<td>2538</td>
</tr>
<tr>
<td>Import Block Model</td>
<td>2539</td>
</tr>
<tr>
<td>Define Grade Parameters</td>
<td>2540</td>
</tr>
<tr>
<td>Draw Block Model</td>
<td>2542</td>
</tr>
<tr>
<td>Label Block Model</td>
<td>2544</td>
</tr>
<tr>
<td>Color Pits by Grade Parameters</td>
<td>2545</td>
</tr>
<tr>
<td>Color Elevation Grid by Block Model</td>
<td>2546</td>
</tr>
<tr>
<td>Block Model Inspector</td>
<td>2548</td>
</tr>
<tr>
<td>Block Model 3D Viewer</td>
<td>2550</td>
</tr>
<tr>
<td>Block Model Statistics</td>
<td>2550</td>
</tr>
<tr>
<td>Prepare Value Block Model</td>
<td>2551</td>
</tr>
<tr>
<td>Optimized Pit Design</td>
<td>2554</td>
</tr>
<tr>
<td>Production By Block Model</td>
<td>2559</td>
</tr>
<tr>
<td>Case Studies</td>
<td>2584</td>
</tr>
<tr>
<td>Case Study #1: Techniques of Geological Compositing</td>
<td>2584</td>
</tr>
<tr>
<td>Case Study #2: Outcrop and Subcrop Modeling</td>
<td>2595</td>
</tr>
<tr>
<td>Case Study #3: Techniques Of Gridding</td>
<td>2603</td>
</tr>
<tr>
<td>Case Study #4: Limestone Block Modeling</td>
<td>2613</td>
</tr>
<tr>
<td>Case Study #5: Block Modeling by Quality Attributes</td>
<td>2630</td>
</tr>
</tbody>
</table>
Chapter 16. Surface Mining Module

Boundary Menu  ................................................................. 2801

Name Pit Polylines ......................................................... 2801
Assign Pit Names By Layer  ............................................. 2802
Find Pit  ................................................................. 2802
Label Pit/Site Names ....................................................... 2802
Pit Label Formatter ........................................................ 2802
Hatch Pits ................................................................. 2804
Identify Pit Polylines ...................................................... 2805
Remove Pit Names .......................................................... 2806
Pit by Interior Point .......................................................... 2806
Pit Plines from Mineplan .................................................. 2806
Pit Matrix Layout ............................................................. 2808
Pit Layout by Advance ...................................................... 2813
Pit Layout by Width ......................................................... 2815
Pit Layout by Rate ............................................................ 2816
Import Pit Points .............................................................. 2819
Merge Pits ................................................................. 2820
Assign Directions ............................................................ 2821
Display Directions ............................................................ 2825
Reverse Directions ........................................................... 2826
Clear Directions ............................................................... 2826
Default Pit Attributes ...................................................... 2827
Assign Pit Precedence ....................................................... 2828
Clear Pit Precedence ........................................................ 2828
Clear Pit Bench Quantities .................................................. 2828
Remove Empty Benches ..................................................... 2829
Assign Pit Attributes ......................................................... 2829
| Contents |
|-------------------|-------------------|
| Reassign Pit Attributes Grids Folder | 2830 |
| Assign Timing Grids | 2830 |
| Reassign Timing Grids Folder | 2831 |
| Import Pit Timing Data | 2831 |
| Pit Quantities Report | 2832 |
| Pit Points Report | 2834 |
| Edit Pit | 2835 |
| Pit Inspector | 2839 |
| Reserves Timing Menu | 2841 |
| Reserves/Timing Menu | 2841 |
| Timing Project Manager | 2841 |
| Define Equipment | 2856 |
| Equipment Calendar | 2859 |
| Set Attribute By Grid File | 2862 |
| Surface Production Timing | 2863 |
| Pit Scheduler | 2868 |
| Surface Equipment Timing | 2873 |
| View 3D Surface History | 2897 |
| Clear Timing Report | 2898 |
| Haul Fleet Manager | 2899 |
| Haul Road Manager | 2901 |
| Haul Cycle Analysis | 2904 |
| Surface Menu | 2908 |
| Define Dragline Equipment | 2909 |
| 3D Dragline | 2910 |
| Range Diagram | 2913 |
| Dozer Push | 2920 |
| Draw Dragline Limits | 2923 |
| Cut and Place (Spoil Removal) | 2924 |
| Cut Only (Coal Removal) | 2928 |
| Flatten Spoil Top | 2929 |
| Cast Blast Profile | 2931 |
| Polyline to Centerline File | 2933 |
| Area To Section Report | 2933 |
| Dragline Section Report | 2934 |
| Process Dragline Sequence | 2935 |
| Design Dragline Pit | 2939 |
| Design Bench Pit | 2941 |
### Chapter 17. Tutorials

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lesson 1: Entering a Deed</td>
<td>3021</td>
</tr>
<tr>
<td>Lesson 2: Making a Plat</td>
<td>3029</td>
</tr>
<tr>
<td>Lesson 3: Field to Finish for Faster Drafting</td>
<td>3064</td>
</tr>
<tr>
<td>Lesson 4: Intersections and Subdivisions</td>
<td>3082</td>
</tr>
<tr>
<td>Lesson 5: SurvNET</td>
<td>3106</td>
</tr>
<tr>
<td>Lesson 6: Contouring, DTM and Design</td>
<td>3127</td>
</tr>
<tr>
<td>Lesson 7: Contouring, Break Lines and Stockpiles</td>
<td>3140</td>
</tr>
<tr>
<td>Lesson 8: A Dozen Tools for Surface Design</td>
<td>3154</td>
</tr>
<tr>
<td>Lesson 9: Calculate Volumes By Five Methods</td>
<td>3169</td>
</tr>
<tr>
<td>Lesson 10: Basic Road Design with Volumes</td>
<td>3188</td>
</tr>
<tr>
<td>Lesson 11: Road Rehabilitation</td>
<td>3208</td>
</tr>
<tr>
<td>Lesson 12: Hydrology and Watershed Analysis</td>
<td>3218</td>
</tr>
<tr>
<td>Lesson 13: Stormwater Network Design</td>
<td>3241</td>
</tr>
<tr>
<td>Lesson 14: Data Extraction for HydroCAD</td>
<td>3264</td>
</tr>
<tr>
<td>Lesson 15: ESRI to Office to Field and Back</td>
<td>3274</td>
</tr>
<tr>
<td>Lesson 16: Takeoff Tutorial: CAD File Takeoff From Start To Finish</td>
<td>3278</td>
</tr>
<tr>
<td>Lesson 17: Takeoff Tutorial: Drillhole and Strata</td>
<td>3308</td>
</tr>
<tr>
<td>Lesson 18: Takeoff Tutorial: Trench Network Quantities</td>
<td>3319</td>
</tr>
<tr>
<td>Lesson 19: Takeoff Tutorial: Digitizing</td>
<td>3338</td>
</tr>
<tr>
<td>Lesson 20: Takeoff Tutorial: PDF Section Import</td>
<td>3373</td>
</tr>
</tbody>
</table>

### Chapter 18. LDT Migration Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3383</td>
</tr>
<tr>
<td>Data File Types and Storage</td>
<td>3383</td>
</tr>
<tr>
<td>Settings</td>
<td>3385</td>
</tr>
<tr>
<td>Survey</td>
<td>3386</td>
</tr>
<tr>
<td>Points and Point Groups</td>
<td>3390</td>
</tr>
<tr>
<td>Surfaces and Contours</td>
<td>3391</td>
</tr>
<tr>
<td>Line and Curve Labeling</td>
<td>3393</td>
</tr>
<tr>
<td>Volumes</td>
<td>3394</td>
</tr>
<tr>
<td>Alignments</td>
<td>3394</td>
</tr>
<tr>
<td>Profiles</td>
<td>3395</td>
</tr>
<tr>
<td>Roadway Cross Sections</td>
<td>3396</td>
</tr>
<tr>
<td>Roadway Templates</td>
<td>3397</td>
</tr>
<tr>
<td>Design Control</td>
<td>3398</td>
</tr>
<tr>
<td>Roadway Intersections</td>
<td>3399</td>
</tr>
<tr>
<td>Cul-de-sacs</td>
<td>3400</td>
</tr>
<tr>
<td>Grading</td>
<td>3401</td>
</tr>
</tbody>
</table>

Contents
Introduction
Introduction

Carlson 2013 is application software for land development, civil engineering, surveying, construction, GIS and mining engineering which runs with AutoCAD and IntelliCAD. The CAD engine serves as the graphics engine and drawing editor for Carlson.

Carlson 2013 consists of the following programs: Survey, Civil, Hydrology, GIS, Field, Takeoff, Construction, Natural Regrade, Point Clouds, Basic Mining, Geology, Underground Mining and Surface Mining. Each of these programs can run independently or together with each other.

Carlson Directory Structure

The figure below shows the default directory structure for the Carlson program files. The EXEC, LSP, and Support sub-directories have files that are accessed by the program. You should never need to access these files directly yourself. The Carlson Projects sub-directories are the user's directories.

ROOT
\Program Files\Carlson2013

\EXEC
Executable
  - Programs (.EXE, .DTA)
\Support - a set of fixed program support files that are not user-customized

Support
  - Help files (.CHM, .PDF)
  - Shared programs (.DLL)
\SupTemplate - a set of support files to be copied to individual user's profile

\LSP
Lisp & ARX
  - Programs (.LSP, .DLL, .ARX, .DCL)
\UserTemplate - a set of files to be copied to individual user's profile

User setup files
  - Settings files (.INI)

\Carlson Projects (customizable during installation)

User data files
  - Survey files (.RW5, .CRD, etc)
Startup directory, user drawings
  - Drawings (.DWG)

Each user on multi-user system gets his own copy of files from support and settings areas. Depending on your operating system the location will vary:
On Windows XP and earlier it would typically be: C:\Documents and Settings\Your User Name\Application Data\Carlson Software\Carlson2013

On Windows Vista would typically be: C:\Users\Your User Name\AppData\Local\Carlson Software\Carlson2013

On Windows 7 would typically be: C:\Users\Your User Name\AppData\Roaming\Carlson Software\Carlson2013 followed by folder name specific to the version of AutoCAD or IntelliCAD you are running. Please note that by default Windows will be hiding the "Application Data" ("AppData" on Vista) location from browsing, but you can still type it in, or change viewing preferences.

**Installation Guide**


What's New - Complete list of improvements for Carlson 2013.

Documentation - For full documentation, including context sensitive help, press the F1 key at any time while running Carlson 2013.

Fixes - A complete list of fixes for Carlson 2013 can be found on at the Carlson Software Knowledge Base.

Support - List of all support resources.

**System Requirements**

Carlson’s system requirements are no greater than that of the AutoCAD ® version you are running. See your AutoCAD installation guide for the minimum system configuration. It is always recommended that you use the highest performance PC possible.

For detailed information on system requirements please see this page: http://www.carlsonsw.com/SystemReqCarlsonProducts.html

Carlson 2013 will operate with the following versions of CAD:

- IntelliCAD 7.2 built-in

On 64-bit Windows (XP, Vista, Windows 7)
- AutoCAD 2013-2009
- AutoCAD Map 2013-2009

Note: Carlson requires a minimum screen resolution of 1024x768.
Please note that AutoCAD (plain or Map) 2008 or later will only install as 64-bit only when used on 64-bit operating system. AutoCAD 2008 64-bit mode is not supported by Carlson 2013. The older AutoCADs or IntelliCAD will install on 64-bit Windows as 32-bit application and Carlson 2013 will install and run properly on these CADs as 32-bit application.

**Workstation Installation**

- Insert the CD and the program will initialize automatically. If the setup program does not automatically begin, click Start, select Run, type D:\Launch.exe and click OK.
- After the program begins, select **Install Carlson 2013**.

![Image of Carlson Setup](image)

- Select which version of CAD you are installing Carlson 2013 on. Users of 64-bit Windows will get additional prompt asking whether they intend to use a 64-bit or 32-bit kind of CAD application.

- During the installation process, you will be prompted for your serial number. This can be found either on the CD case or on your distribution sheet. **IMPORTANT: Each legal copy of Carlson 2013 has its own serial number.**
- Specify which folder you prefer to install Carlson 2013 in. In case of using multiple versions of AutoCAD, please select individual folders of Carlson 2013 for each version.
- Select Install Type:
Most people will choose Full install. In the case of Remote install some of the program files will reside on the server location. To do a Remote Install, please run a Full install on the server, followed by Remote installs on workstations. This mode will NOT give you a network license though, and it is NOT required for people running a network license.

- Work and Data folders. Workgroups may choose to store their drawings and data files in the central location. Please specify where the program should look for files.

- You will be prompted for profile to use as a template. This is an optional input to be used when there is an existing company CAD profile you would like to use as a template for setting up a separate Carlson 2013 profile. Leave blank if there is no need in this feature.

- Review the installation options, and click "Next" to continue:
In the course of your installation, you may get a prompt to carry over your settings if you had SurvCADD installed on your system. Please state your preference:

At this point, installation will start. After all the files have been copied, you have to select which copy of AutoCAD you will be using, as you may have multiple AutoCAD verticals installed on the same system. It you see installation take long time without any apparent activity, please make sure any other applications on computer are shutdown. This delay is caused by component registration waiting for other applications to exit.

Installation will create a separate shortcut on your desktop for each major component of the program.

**Performing Silent (Scripted) Installation**

Whenever an administrator needs to install several identical computers, it may be beneficial to install once recording all the input and then deploy the rest of the computers using the input recorded when installing on the first one.

Carlson is using InstallShield InstallScript engine which supports this feature in the following manner:

- Start command prompt and change to the drive letter corresponding to CD-ROM drive where Carlson disc is
• Run Carlson install with additional switches like this:

```
setup.exe /r /f1c:\some_folder\setup.iss /f2c:\some_folder\setup.log
```

where /r designates recording, /f1 response file and /f2 log file. Please note lack of space after /f switches. Apparently simple paths with no special (non-alpha) characters are required.

• Copy setup.iss to location accessible on the network
• On the target machine, run the setup as the following

```
setup.exe /s /f1network_folder\setup.iss /f2c:\some_folder\setup.log
```

where /s designates silent install, /f1 pre-recorded response file and /f2 log file
• The install runs very stealthy and does not generate any messages. The log file will contain return code of 0 on successful install.

Please note that this method will use identical Carlson serial number on all the silently installed machines. This is correct in case of network license mode, but is not proper for standalone licenses. In that case, prior to registration, please navigate to Help, About Carlson, Change registration, remove scripted number and enter proper unique serial number assigned to the workstation. After that, the new number is OK to register.

### Network License Server Installation

For network licensing server installation instructions, click here or go to the Knowledge Base at www.carlsonsw.com.

### Running for the first time

When you launch the program for the first time, it will try to connect to the updates server, to see if any program updates has been posted since the CD was created. Unless you indicate otherwise, the program will do this on a weekly basis, to make sure that your Carlson product is up to date on fixes to all known problems.

### Registration

IMPORTANT! ALL INSTALLATIONS OF THIS SOFTWARE REQUIRE A UNIQUE SERIAL NUMBER. If you are running this software on more computers than you have purchased licenses for, you must buy additional copies.

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.
Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

**Fax:** This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

**Internet:** Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter pre-authorized change key:** If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.

**Register Later:** If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing. Choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process, and use the Fax method. There is more registration information on the Carlson Software website at [http://www.carlsonsw.com/registration.html](http://www.carlsonsw.com/registration.html).

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button. This also allows you to add additional serial numbers you purchased without reinstalling software. Each serial number requires separate registration.

---

**via Discussion Groups**

- Carlson Software operates user discussion groups located at [http://update.carlsonsw.com/phpBB2](http://update.carlsonsw.com/phpBB2). You can participate in user-to-user discussion on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at [http://www.carlsonsw.com](http://www.carlsonsw.com) for information on how to access these groups.

**via Electronic Mail**

- The Technical Support e-mail address is support@carlsonsw.com.
via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site

Check the Carlson Software Web Site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

Starting AutoCAD with Carlson

To start Carlson, use the icon which was created on your desktop and in Carlson submenu under Start > Programs (or All Programs). When you do so, CAD engine associated with Carlson is started with a customized profile, which contains all of the setting changes necessary to run Carlson. This profile prevents harmful conflicts between Carlson and other CAD based products. The changes in menus, toolbars and preferences will be saved in that profile for further use. The CAD engine associated with Carlson is selected during the installation of Carlson.

Custom Template Profile Name

The company with the internal CAD profile setup can specify the desired profile name to be used as a template for setting up Carlson 2013. The existing template will be copied and new profile for Carlson 2013 will be created, changing minimal number of settings required to run Carlson. As a result, most of the profile will match company setup and no further customization will be necessary.

License Models

Carlson Software supports a multitude of the license models to better fit the specific needs of the customer. There is three retail license modes: regular standalone license, network license and hardware lock license. There are four additional special license modes: a demo license, not for resale license, educational standalone and educational network license. These license modes as well as their features, benefits and restrictions are described with further details below.

Standalone license model

This is the most typical license model. The user is issued a serial number containing a license to run one or more modules of Carlson application. This authorizes user to install and register software on one machine and one machine only. The exception is made for use of home or laptop computer of the same person. Both computers have to be registered online and home/laptop system is specifically designated during the registration.
Multiple serial numbers containing separate features can be combined within the same installation by entering them in Change Registration dialog, found under Help, About Carlson.

When the computer is no longer available and software needs to be moved onto the new system, the move can be performed by using hardware upgrade option during registration, which marks old system as decommissioned and allows registration on new system.

The upgrade serial numbers are tied to the original serial numbers from the older version and continued use of older version is only allowed if upgrade serial number is used on the same system as original serial number. Otherwise the use of the original serial number is terminated within 60 days of the upgrade registration on different system.

**Network license model**

This is the license models used by the larger companies needing flexibility of the software licensing when license is not tied to a particular machine. The company is purchasing a pool of licenses consisting of the appropriate count of individual modules to better fit the needs of its users. The pool can be expanded by adding more licenses at later date.

The licenses are loaded into the license server and software is installed locally on the workstations with a network serial number instructing software to look for the license on the network server. For details on the installation process, please refer to the Installation Guide found on CD. Procedure for requesting and installing the license on the server is outlined in the Knowledge base: http://update.carlsonsw.com/kbase_main.php?action=display_topic&topic_id=55.

Even if purchased as "seat" or as a part of the Suite, the modules are treated by the license server as individual modules, allowing separate users to have simultaneous use of separate modules from the same "seat". Each user is going to request and hold the license for the module he is currently uses. That license is held as long as the program is running. When user switches the modules, the held license is released and new module license is acquired.

The network license mode does not allow for the home/laptop license the standalone license mode has, but it allows users to use WAN or VPN software to get licenses from the remote servers over the network and it allows to commute the license from the server and install the license temporarily on the workstation. Commuting is discussed in further detail in the Administrator's guide included with the license server. The commuted license automatically returns to the server when it is expires or it can be returned by user earlier when computer returns to the network. Licenses commuted from the server are not available to other users contacting the server for the license, so commuting essentially decreases the server license pool for the commute period.

Software configured to use any serial numbers with network license mode enabled can not use any serial numbers with other license models enabled - it will treat them all as network license serial numbers. Therefore it is not possible to share a module on network but have other modules in standalone mode.

**Hardware lock licensing**

In this model, the physical hardware key is issued. This key is an USB device which has to be plugged in to the computer in order for the computer to be able to use software. This allows a single user to setup software on multiple computers or even locations and carry his license with him in form of USB device. This is also a primary model of licensing in the countries where software-only protection is not considered sufficient protection due to rampant software piracy.

User is responsible for the cost of the device in addition to the cost of the software itself if this licensing model is employed.
Demo license model

Demo serial numbers allow full use of software within the demo period. The license is limited both by the duration and built-in use counter. Once the demo period expires, the user can get extensions from Carlson customer service in two week increments if there is a demonstrated need to continue with decision process.

Educational institutional license

Accredited institution can receive the network license for the institutional license server for the purpose of teaching course on Carlson software at a nominal cost of software maintenance instead of list price. The university will be responsible for student support and for commuting the licenses for student use in the course. For all practical purposes this is a regular network license, except for the different pricing structure.

Educational student license model

Students currently enrolled at college can purchase a significantly discounted standalone license which will run for 1 year from the date of purchase. A proof of enrollment is required and software running in this mode will be checking online weekly for license extension until 1 year runs out. After this, the additional purchase is required if enrollment remains current. Second and home computers are not allowed with this license model.

Not for resale license model

This is essentially a standalone license model governed by additional restrictions of license use. Serial numbers designated as "not for resale" are issued only to Carlson personnel and Carlson resellers. These licenses should never be installed at end-user systems or sold to the end-user. Such use constitutes a violation of Carlson agreements.

Carlson Registration

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name, Carlson serial number and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.
Fax: This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

Internet: Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

Enter pre-authorized change key: If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.

Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

**Tablet Template**

If you have a digitizer you will probably want to plot a copy of the Carlson tablet menu. After installing Carlson, start Carlson and plot a copy of the drawing file TABLET.DWG located in the Carlson support directory (ie: \Carlson2013\SUP\TABLET.DWG), at a scale of 1=1. You may want to review the drawing in the drawing editor to determine layer names and colors to set up a color version of the template. You can also modify this drawing to add your own symbols and details to the tablet menu. After plotting, secure the Carlson template drawing to your digitizer. The proper scale is 1=1 for a 12" x 12" tablet. It can also be plotted at a smaller or larger scale to suit other tablet sizes.

Once you have a hard copy of the tablet, the tablet needs to be configured. Type TABLET at the command prompt. Refer to the CAD Reference Manual for details on the menu area points and number of columns and rows. The tablet template is in the standard template format which means if you are using any other templates you can easily switch between different control menus.
Troubleshooting Setup

To install Carlson 2013 on Windows NT4.0, Windows 2000, Windows XP or Windows 7, you must have Administrator permissions to write to the system registry during the install.

Successful install of Carlson consists of four key items:

1. Windows registry settings
2. Carlson icon on desktop and in the Start menu
3. Carlson 2013 profile created in AutoCAD or IntelliCAD
4. carlson.ini configuration file in USER sub-directory of Carlson

If you have trouble starting or running Carlson 2013 after installation, using Windows Explorer, go to the Carlson \USER directory and run the SCJSTART.EXE executable. To open Windows Explorer, click Start, point to All Programs, point to Accessories, and then click Windows Explorer.

If this does not fix the problem, please re-install the software making note of any possible error messages before contacting Technical Support.

Desktop and Menu icons for Carlson 2013

A Carlson specific profile is used in order to configure Carlson correctly and start the Carlson menu when AutoCAD or IntelliCAD starts. Profiles are used by the CAD to separate different product environments.

The default profile to use is supplied by the Carlson startup program. To verify that your Carlson icon is set up correctly, do the following:

• Right click on the Carlson icon and select Properties. Click on the Shortcut tab.
• Target field should contain the following executable SCJSTART.EXE (located in the Carlson\USER directory).
• Work directory defaults to the same directory where drawings are stored
• Make changes as needed and click OK.
Checking Carlson.INI configuration file.

The last step in troubleshooting the installation is to verify the Carlson.INI file in the Carlson USER directory. Open that file using Notepad (Click Start, Programs, Accessories, Notepad) or any other editor. Then verify and/or modify the top few lines to match your setup. Save it and restart Carlson.

If the procedures outlined above did not help or you have trouble following them, please feel free to contact Carlson Software Tech Support.

Loading Carlson Menus

The Carlson programs are loaded when the Carlson menu is loaded. The Carlson menu is named cs##base.mnu (for AutoCAD 2005 and earlier) or cs##base.cui (for AutoCAD 2006 and later) where the ## is the version of AutoCAD or icadbase.mnu for IntelliCAD. For example, in AutoCAD 2007 the Carlson menu name is cs07base.cui. The Carlson menu is located in the Carlson SUP folder. The Carlson installation and desktop icons should automatically setup AutoCAD to load the Carlson menu. To manually load the Carlson menu, first make sure that the Carlson SUP folder is listed in the Support File Search Path under AutoCAD or IntelliCAD Options. Then run the menuload or cuiload AutoCAD command or the menu IntelliCAD command and load the Carlson menu. The Carlson SUP folder is under the Windows user folder such as:

\Users\your name\appdata\roaming\Carlson Software\Carlson_Version\CAD_Version\SUP

The Carlson menu has over 80 pull-down menus for the different Carlson programs. Each program has its own set of pull-down menus. The menu set for one program is active at a time. To switch current program menu, choose the menu from Settings>Carlson Menus or choose from the Modules toolbar.
By default, the Carlson menu is setup as the Main Customization File in AutoCAD. To setup the Carlson menu as the partial menu,
1. Start AutoCAD with Carlson by using the Carlson desktop icon
2. Run CUILOAD and unload all the menus. Then load your Main Customization File. Then load the Carlson menu.
3. In Carlson Configure->Startup Settings, turn on No Menu Reset.

Obtaining Technical Support

via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.

via Electronic Mail

- The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site
Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training
- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the command prompt. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Options dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and CAD commands. This allows you to execute the commonly used CAD commands from the menus while running Carlson.

Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

For command entry at the Command: prompt, pressing Enter repeats the last command. Also the prompt history records the sequence of previous commands, and you can run these previous commands without invoking the menu. To access the commands, use the keyboard up and down arrows. The up arrow moves backwards in the history and the down arrow moves forward. As you press the arrows, the previous command names appear at the command prompt. When you get to the command that you want to run again, press Enter.

**Transparent Commands**

Transparent commands can be issued at the Command: prompt while running other commands without exiting the current command. The transparent command will run and then return to the current command. To run a transparent command, you can either type in the command name or pick a button on the Transparent Command toolbar. There are seven Carlson transparent commands. These commands can be used at any command prompt that is for a point location.

'2: Gets the 2D (x,y) coordinate by point number from the current coordinate file. You can enter a single point number or a range of points (ie 1-10).
'3: Gets the 3D (x,y,z) coordinate by point number from the current coordinate file.
'CL: Gets a point by station-offset from a centerline. The routine prompts for a centerline, station and offset left or right. The position along the centerline can be specified by entering the station, picking a point that gets projected onto the centerline, or by a distance factor. The 'CL command can be used as a Perpendicular From snap by picking a centerline and entering a station to come perpendicular from (the routine defaults to the station of the last point)
and then entering an offset for the perpendicular distance.

'CENTROID: Gets a point that is the centroid position for a closed polyline. The routine prompts for the polyline to process.

'TANGPT: Gets a point that is tangent to the selected centerline or polyline. The routine prompts for the centerline, station and distance. The station defaults to the position along the centerline of the last picked point.

'BBPT: Gets a point by Bearing-Bearing Intersection. The routine follows the same prompts as the Bearing-Bearing Intersect command in the COGO menu.

'BDPT: Gets a point by Bearing-Distance Intersection. The routine follows the same prompts as the Bearing-Distance Intersect command in the COGO menu.

'DDPT: Gets a point by Distance-Distance Intersection. The routine follows the same prompts as the Distance-Distance Intersect command in the COGO menu.

Prompts
For '2 to draw a polyline from points 100-102.
Command: pl
PLINE
Specify start point: 2
>>> Enter point numbers: 100-102
Resuming PLINE command.
Specify start point: 10308.02109999,10213.95245576
Current line-width is 0.00
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
10307.46576250,10214.50318930
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:
10268.05722717,10245.06058831
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: press Enter to end

For 'CL to draw a polyline starting at station 200, right 50 from a centerline:
Command: pl
PLINE
Specify start point: 'cl
>>> CL File/Select centerline polyline>: pick a polyline
>>> Station range: 0.00 to 256.36
>>> Factor/Pick point on centerline or Enter Station <191.162> >>>: 200
>>> Centerline starting station <0.0>: press Enter to use zero
>>> Offset (negative for left): 50
Resuming PLINE command.
Specify start point: 5155.46856081,5271.30066060
Current line-width is 0.00
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: pick a point
What is New

General
AutoCAD 2013 - Added support for this new version.
IntelliCAD 7.2 - Improved performance and stability.
Ribbons - New ribbon user-interface with ribbons for General, Survey, Civil and Takeoff.
Toolbars - Added 173 new toolbar icons.
Symbol Library - Added 22 new symbols.
Linetypes - Added 9 new linetypes.
Hatch - Added 30 new hatch patterns.
Barscale - Added two new barscale styles.
Twist to 3D View - New command to rotate points, symbols and text to face the current 3D viewpoint.
Draw Box Around Text - Added settings for gap offset and whether to round corners.
Draw Item - Added support for using point #’s from the current coordinate file and for creating 3D polylines.
Freeze Layer By Pick - New command to pick individual entity on layer to freeze.
Erase By Layer - Added functions to save and load layer selections.
Export Google Earth - Added ability to export point entities. Added support for layer and color attributes. Added support to create kmz files as well as kml.
Import Google Earth - New command to import points and linework from kml file.

Survey Commands
CRDB - New coordinate file format built on SQLite database for better performance than MDB.
Search Published Control - New command to lookup points from NGS geodetic control database.
Edit-Process Raw File - Added method to display only selected point range and hide the rest.
Field-To-Finish - Many new coding methods for tree surveys including coding by description sequence, by GIS attribute or by user-defined special characters. Also added method to draw circle for drip radius, method to draw circle for truck radius and method to draw polyline for treeline perimeter. Added function to generate tree table and reports based on tree coding in the point descriptions. For general point reports, added option to use the report formatter and include fields for the dwg description and code full name. For GIS labeling, added settings for decimal places and custom symbol attributes as reals. Also for GIS processing, added support for using GIS attribute for special codes such as horizontal offset. For ROT special code, added method to rotate by description using companion codes.
Edit-Multiple Point Attributes - New user-interface with tabbed dialog. Added method to change attribute colors. Added ability to toggle visibility of attributes.
Edit-Process Deed File - Added method to use label precision for calculating closure.
Twist Screen Surveyor - Added option to use grid mapping angle.
Inverse - Added option to report distances as delta north-south-east-west. Added option to report lat/lon. Added option whether to report coordinates.
Draw Locate Points - Added method to create points by entering lat/lon.
Bearing/Bearing Intersect - Added support for geodetic bearings.
Distance Between Entities - Added average distance to the report.
Map Check By Screen Entities - Added options whether to auto-select entities and set max offset.
Best-Fit Point - New command to average points and report statistics.
Cut Sheets - New spreadsheet interface, import from SurvCE and plan view labeling methods.
Lot File Manager - Added function to hatch lots.
Angle/Distance Annotation - Added settings for bearing quadrant labels. Added control for arrow size for end point leaders. Added separate settings for justification of angle and distance labels. Added option for prefix for distance labels.
North Arrows - Added ability to add custom north arrow symbols.
Label Coordinates - Added style for labels along X/Y axis.
Label Lat/Lon - Added real-time display of lat/lon while picking points to label.
Area Labels - Added option to use grid to ground conversion to label geodetic areas.
Geodetic Single Proportion - New command to split line by proportion between record part and total distances.
Geodetic Double Break - New command to break two intersecting lines based on mean bearing.
Geodetic Middle Break - New command splits line to make lines with same geodetic length and mean bearing.
Grant Boundary Adjustment - New command to apply Grant boundary adjustment on closed polylines.

**Civil Commands**
Centerlines - Added support for non-tangent spirals.
Station Polyline/Centerline - Added settings for deflection angle precision. For polylines on a profile grid, added setting for vertical exaggeration.
Label Station Offset - Added option for arrow on leader.
Draw Profile - Added method to label linework that crosses reference centerline. In options dialog, added screen pick method for dimensions like plan view window size. Added option for output to DWG to have separate DWG for each layout. In metric mode, added unit setting for pipe size labels as m, cm or mm. For horizontal axis labels, added settings for prefix/suffix on elevation labels. Also for horizontal axis elevations, added option to draw tick and option for separate interval along curves. For sewer labels, added control for vertical shift of labels with leaders, added method to place manhole label as offset from rim, and added controls for different combos of pipe length and slope labels. For sheets, new setting for whether to label sheet #. Added option for separate rows to crossing labels with vertical lines.
Profile Report - Added support for reporting elevations and cut/fill for any number of profiles at once.
Draw Sections - Added option to hatch cut/fill end areas. In metric mode, added unit setting for pipe size labels as m, cm or mm. For sheet output, added option for all in same layout or separate layout for each sheet.
Label Profile On Centerline - Added method to label at station interval.
Calculate Section Volumes - Added support for cut/fill gap stations.
Lock Sections - Added method in Input-Edit Section File to lock sections to prevent changes by any routines.
Input-Edit Section File - Added display of end areas when editing two section files.
Mass Haul Analysis - Added average haul distance per range to report. Added support for cut/fill gap stations.
Template Transition - Added report function.
Template Point Profile - Added report function.
Template Point Centerline - Added report function.
Road Network - Added cut/fill gap stations per road. In Show Sections review, added method to go to specific station. Added setting for transition distance from template ID at intersections. For report, added option to use report formatter.
Draw Spot Elevations - Added option for vertical offset and option to label a second elevation. Added method to use 3D polylines for elevation reference and added option to link labels to the reference polylines.
Set Point Elevations By 3D Polylines - Added option to link elevations to reference polylines.
Set Point Elevations By Surface Model - Added option to link elevations to surface model.
Cut/Fill Grid Map - New command to label cut/fill quantities at a grid interval.
Elevate Text - New command to set elevation of text entities by values in the text labels.
Edit Wall Polyline Profiles - New command to define 3D wall for surface modeling by top and bottom profiles.
Triangulate & Contour - Added option to control number of digits in elevation labels and put comma in labels for values in thousands.
Contour Elevation Label - Added options to label ends of contour lines and to align labels facing uphill.
Draw Contour Gradient Marks - New command to draw tick marks along contour to show slope direction.
Cut/Fill Slopes Lines - Added options to hatch slope areas and to use different slope symbols.
Draw Surface Boundary - Option to label polyline perimeter with user-specified text at an interval.
Triangulation Surface Volumes - Added ability to report staging volumes.

**Hydrology Commands**
Design Bench Pond - Added option for sloped pond bottom.
Design Valley Pond - Updated user-interface with new options dialog.
Sewer Network - Added method for headwall with skew rotation.
Lateral Design - New lateral structure types for sewer network plus reporting and profiles.
Plan View Labels - Added label options for deflection angle, structure description, northing and easting values. Added option to add pipe material to invert-out label. Added setting for separate layer for outside line of dashed thick linetype.
Sewer Spreadsheet Editor - Made dialog resizable.
Pipe Profile Label - New command to label bottom or top of pipe elevations at picked locations.
Library Files - Added default libraries for pipe and rainfall for North Carolina and Kentucky standards.

GIS Commands
Create Image From Drawing - New command to create a georeferenced image from the drawing entities.
Esri ArcGIS Services - Added support for server 10.x.
SQLite - Added support for SQLite databases in addition to MDB and ESRI MSC.

Geology Commands
CDB - New drillhole database format built on SQLite for better performance than MDB.
Define Drillhole - New user interface with spreadsheets. Added method to restrict strata/bed/attribute names to pre-defined lists.
Define Lookup Database - New command to define drillhole and custom attribute tables.
Edit Drillhole - New user interface with spreadsheet. New functions to lookup strata and bed names from pre-defined lists. Added options to color strata by strata definition or by grade parameters.
Drillhole Data Sheet - Added function to run Edit Drillhole for selected drillhole.
Drillhole Core Images - New command assign core images to depth ranges of drillhole.
Drillhole Text Formatter - Added method to set text rotation per text field. Added option to create mtext.
Select Drillholes By Filter - New command to build selection of drillhole by parameter filters.
Auto-Run Isopach Maps - Added setting for whether to extrapolate models from grid files.
Fence Diagram - Added support for angled drillholes and drawing multiple additional surfaces.
Quick Geologic Column - New command to show selected drillholes in section view.
Geologic Column - Added options to draw mtext labels and to create a block of the geologic column entities. Added setting to control offset amount between columns.
Define Grade Parameters - Added support for up to 50 attributes to define grades.
Grid File Utilities - Scripts allow a custom message for file selection and perimeter selection prompts.

Surface/Underground Mining Commands
Range Diagram - New command to design cut/place for dragline with dynamic graphics and reports.
Design Bench Pit - Added support for using TINs as surface model in addition to grids. Added setting for minimum bench height. Added method to process multiple pits by using Timing file (TIM) for sequencing.
Quantities By Grid Method - Added options to set grid resolution and choose modeling method.
Recalculate Extraction - Added additional layer capture ability: entry width and attribute group.
Assign Timing Grids - Added auto-run method to make assignments.
Surface History - Added support for TINs in addition to grid surfaces.
Hatch Pits - New command to hatch pit polylines.
Surface Equipment Timing - Added method to assign block sequence by rules. In 3D pit scheduling, added real-time display of selected quantities and qualities. Also, in 3D pick window, added time slider and scheduling information. Weight qualities by volume instead of area. Added ability to define precedence rules as formulas to be applied automatically based on custom naming strategy. Timing window has new function to adjust sorting of unassigned pit/panels so that precedence is satisfied. Added ability to define how attributes are weighted by another attribute. Pit attribute data is moved to the extension dictionary to allow for more attributes to be assigned.
Underground Equipment Timing - additional option for the timing events to affect only secondary units and not the unit encountering the event.
Spoil Placement Timing - Added swell factor and added time available to place volumes.

TakeOff Commands
Drawing Cleanup - Added method to rename layers with wildcard characters in names.
Cut/Fill Color Map - Added two more coloring schemes.
Report Subgrade Areas - New command to report areas by subgrade type.
Make Surfaces - Added option to minimize flat triangles.
Make Existing Surface - Added drillhole surface elevations into surface model.
3D Drive Simulation - Added display of current coordinates and option for reference CL for station-offset.
Point Cloud Commands
Snap Modes - Added new snap modes for top of slopes and bottom of slope.

Data Conversions
ESRI - Added function to export ESRI grid surfaces from Grid File Utilities.
Geoids - Added three Bayern geoids and GCG05-KUESTE geoid for Germany, Romanian geoid, Papua New Guinea geoid, Slovenia geoid, Croatian HRG2009 geoid and TRST geoid.
Horizon - Added import for Horizon raw data.
Minex - Added import for Minex grids in Grid File Utilities.
Vulcan - Added imports for Vulcan grids and Vulcan block models.

Setting Up a Project

Over 200 program settings can be specified in the Configure command under the Settings menu. These values are used to initialize Carlson program options when opening a new or existing drawing. Among these settings is the coordinate point number format, file and printer output options and settings for each module.

To set the drawing defaults, edit the template drawing (.DWT file). This drawing is loaded when new drawings are created. In the template drawing you can set the layers and AutoCAD /IntelliCAD variables. For example you could create your standard layers and set variables as you like such as BLIPMODE off. For Carlson, the drawing template should be set to Carlson##.dwt where the ## is the AutoCAD version number. For Carlson running in AutoCAD 2007, the template name is Carlson07.dwt. The Carlson template is located in the Carlson support directory (i.e. C:\Carlson2008\SUP\Carlson07.dwt). To customize the template, run the OPEN command and choose the drawing template. In the Select File dialog, set the type of file to Drawing Template (DWT) instead of regular drawings (DWG). Then make your changes and SAVE the drawing as Carlson##.dwt.

When starting a new drawing, one of the first steps is to run Drawing Setup under the Settings menu. Drawing Setup sets the drawing scale, the unit mode as either English or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure. When a drawing is saved, the Drawing Setup variables are saved with the drawing.

In Carlson, the text style height should be set to zero. The Carlson routines will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson will draw the text with a height of 5 (50 * 0.1). Then when the drawing is plotted at 1"=50', the text will be 0.1 inches. Use the STYLE command to set the text style height to zero.

The Set Data Directory command in the Settings menu can be used to specify the directory for the project data files. By default the drawing is stored in the Carlson WORK directory and the data files are stored in the DATA directory. The drawing file is the (.DWG) file. The data files are the coordinate (.CRD) file, profile (.PRO) file, grid (.GRD) file and other Carlson data files. In Configure>Project/Data Folders, there is an option to store all data files in the directory of the drawing. With this option active all the files for the drawing C:\Carlson2008\Work\JOB500\JOB500.dwg would be stored in C:\SCAD2006\WORK\JOB500.

Another level of file management is the automatic project file recall. Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE, SAVEAS, or QSAVE command, Carlson writes a settings file that contains all the active data file names. Then when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same directory as the drawing file and has the same name as the drawing with a .INI extension. For example, a drawing survey.dwg would have a settings file called survey.ini. You can turn off the INI files with the Save Drawing INI Files option in Configure under General Settings.
New/Startup Wizard

The New command is used for starting a new Carlson drawing. This page describes this New command and the Startup Wizard, along with the Carlson variables, associated with it.

Built into this routine is a Startup Wizard that can step you through and make the new Carlson drawing setup process easier. For creating a new drawing in Carlson, the Startup Wizard guides you through starting and setting up the drawing. This wizard is optional, and can be turned on or off in the Configure > General Settings command, which is part of the File pulldown. There is also a dialog box option, shown and mentioned below, that allows you to disable this feature. You can also exit out of the Startup Wizard at any time.

When the New drawing command is executed, you first get the standard Select template dialog box. While there are many templates to choose from, and there is an Open option, typically you want to go with choosing the Carlson drawing template (CARLSON07.DWT). The drawing template will set of some basic drawing parameters such as default layer names.

After selecting the template, the Carlson Startup Wizard begins by opening the New Drawing Wizard dialog box.
This dialog is used to set the drawing name and scale. The first step to do is set the drawing (.DWG) name by picking the Set button. This brings up the file selection dialog. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. To select an existing folder, pull down the Save in field to select a folder or drive, click the Move Up icon next to the Save in field and/or the pick the folder name from the list. To create a new folder, pick the Create New Folder icon to the right of the Save in field. Then type in the drawing name in the File name field and click the Save button.

After setting the drawing name, you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Notice that at the lower left corner of the New Drawing Wizard dialog there is an option to Skip Startup Wizard Next Time. Typically, you would leave this option unchecked, as the Wizard is a handy tool for new drawing setup. Now click the Next button.

The next startup dialog sets the Data Path and CRD File. The Data Path is the folder where Carlson will store the data files such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information. The coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate (.CRD) file. The new option will erase any point data that is found in the specified CRD file. The existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.
The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. The Current CRD File option is a popular one to choose for bringing in coordinates. If the None option is set, then the Startup Wizard is finished.

Once point data has been imported from the data collector, text/ASCII file or CRD file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

Pulldown Menu Location: File
Keyboard Command: new
Prerequisite: None

Layer and Style Defaults

Many Carlson commands have default layers such as AREATXT for area labels and BRGTXT for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands and several can be set in Configure. Sometimes you may want to use the current layer and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that set in the dialog, the default layer can be set as "CLAYER" which will use the current layer. For example, if the annotation layer is set to CLAYER then annotation will be drawn in the current layer instead of BRGTXT or whatever the annotation layer used to be.

This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.
Carlson File Types

.AAN Auto-Annotate Settings
.ADF Annotation Default Settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CGC C&G Coordinate File
.CGR C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.COG CadVantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CRB Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.CTL SDMS Format Raw Data
.CTR Auto-Run Strata Isopach Maps
.CUI Customized User Interface AutoCAD Menu
.CUT SMI Format Cutsheet
.CVX SEDCAD Format Hydro Network
.DAT GPS Localization Definition
.DCF Deed Correlation File
.DCL Carlson dialogs
.DEM Digital Elevation Model
.DEQ Drillhole equations
.DHF Drillhole Text File
.DHT Dragline History
.DIL StrataCalc Convert As-Determined Qualities
.DLL Carlson programs files
.DTF Drillhole Data Format
.DTS Drillhole Text Settings
.DWG Drawings
.DXF Drawing Exchange Format
.DZR Dozer Push Settings
.EQO Mining equipment options
.EQU Mining equipment definitions
.ERD Erodible Channel Settings
Chapter 1. Introduction
Throughout Carlson Software, various commands create, utilize or interact with data in files that support the project you are working with. The File Selector dialog box provides a common interface for identifying new and/or utilizing existing data files:

File Selector - New File tab
File Selector - Existing Files tab

**Recent Folders:** When working within a project, the default folder location for a given file type is determined through the Data Folder Setup routine. Use the drop-down control to ensure that the desired folder location is specified to locate or store the desired file.

**File Name:** Indicate and/or **Browse** for the desired file name. If a file extension is not provided with the file name, the first file extension listed in the dialog box header will be utilized.

### Controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Location]</td>
<td>Quickly browse for a desired folder location if the folder location is not displayed in the <strong>Recent Folders</strong> drop-list.</td>
</tr>
<tr>
<td>![File Name]</td>
<td>Existing File tab only. Quickly search for file(s) that meet specific file properties. See the Find File section for additional information.</td>
</tr>
<tr>
<td>![Recent Folders]</td>
<td>Re-assigns the currently selected folder in the <strong>Recent Folders</strong> drop-list as the new <strong>Data Folder</strong>. Use the Set Project/Data Folder → <strong>Re-assign Data Folders</strong> option as needed to restore the Data folder.</td>
</tr>
<tr>
<td>![Controls]</td>
<td>Allows the management of Recent and Favorite folders as described below:</td>
</tr>
</tbody>
</table>

Controls
Recent Folders: Displays the list of recent folders.

Set as Data: Performs the same action as the Set Data Button.

Add as Favorite: Adds the currently selected folder as a favorite folder.

Favorite Folders: Displays the list of favorite folders (folders that are typically used or accessed repeatedly across projects).

Set as Data: Performs the same action as the Set Data Button.

Add: Allows any folder to be located and added as a favorite.

Delete: Removes the selected folder from the Favorite Folders list but does not delete any content found within the folder.

As the data files and folders for project(s) start to increase, the Find File option provides a mechanism to search for a particular file which meet certain file characteristics (all user-specified characteristics must met for the file(s) to be located):
Name Contains: Identify the string of characters located in the file name. For example, Base would return "BaseMap", "basement", "Subbase", etc.

Type: Indicate the specific file extension to be searched (the drop-list selection adjusts according to what is expected by the underlying command).

Newer than: Locate the file(s) that have been modified after the specified date.

Older than: Locate the file(s) that have been modified prior to the specified date.

Larger than: Locate the file(s) whose file size is larger than the value specified.

Smaller than: Locate the file(s) whose file size is smaller than the value specified.

Look in: Locate the file(s) in just the folder that is specified.

Include Subfolders: When enabled, the Look in folder is searched along with any sub-folders.

Start: Manually initiate the Find File routine.

As file(s) are located, select/highlight the desired file and click the OK button to return to the File Selector dialog box.

Note:

• In most cases, when a file name is typed into the Existing tab of the File Selector dialog box that does not exist in the Recent Folders, the routine will alert you the file does not exist and prompts if it should be created. If you instruct the program to create the file, it carries out the action of the New File tab.

Pulldown Menu Location(s): -none-

Keyboard Command: -none-

Prerequisite: -none-

Standard Report Viewer

Many Carlson routines display output in the Standard Report Viewer as shown below. A project name and job number can be added to the report header by filling out values for them in the Settings->Drawing Setup command. The format for the date in the upper right of the report is controlled by the Date Format setting in Settings->Configure->General Settings. The report can be edited directly in the report viewer. Report Viewer commands are described below.

Open: This allows you to open an ASCII file and display the contents in the report viewer.

Save: Save the contents of the report viewer to a text file.

SaveAs: This allows you to save the contents of the report viewer to a file.

Append To: This allows you to append the contents of the report viewer to another file.

Print: Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

Screen: Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

Undo: Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Select All: Selects all the text in the report viewer.

Cut: Deletes the selected text and places it on the Windows® clipboard.

Copy: Copies the selected text to the Windows® clipboard.

Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.

Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.

Chapter 1. Introduction
Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.

Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.

Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

Report Formatter Dialog

The Carlson Report Formatter routine is a highly customizable and flexible reporting engine that can be used to create a variety of output document types. A number of Carlson routines provide an option to use Report Formatter Options and allows you to specify how and which results of calculations should be presented in the report. In addition to the Standard Report Viewer, reports can be generated in web-friendly HTML format along with data formats compatible with Microsoft Excel or Microsoft Access.

Format: Select an available report format from the list of pre-established report configurations or key-in a new report format name.

Save: Saves the current configuration of the active report format. To save a new version of the format, type in a new name (or use the current name to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine, it will recall this last format. To pick another format, select from list of formats in the left top corner and pick which format to use.

Delete: Removes the current report configuration from the listing of available report formats.

Export: Sends ALL available report formats to an XML-based "formatter style" (*.FMS) file.

Import: Imports the contents of a previously exported *.FMS file.
Moves the selected report option in the Used listing above the preceding entry until it reaches the top of the list. Moves the currently selected item from the Available listing to the Used listing. Removes the currently selected item from the Used listing and makes it selectable once again to the Available listing. Moves the selected report option in the Used listing below the following entry until it reaches the bottom of the list.

Report Content Controls

Sort Field: For the selected "field" of data, indicate its sort method:

- **Hold**: The given field is not sorted and prohibits the sorting of subsequent columns.
- **Up**: The given field is sorted in ascending order.
- **Down**: The given field is sorted in descending order.
- **Ignore**: The given field is not sorted and permits sorting for the next column(s).

Columnar Format: When enabled, this toggle groups a given field of data into a column in the report. When disabled, each field of data is placed onto its own row in the report (the report data is output in a single column).

Mirror the Columns: (Suggested for short reports only). When enabled, this toggle transposes columns from the report into rows and vice versa.

Display Table Header: When enabled and exporting the report to an HTML Report format, the field "keys" as defined in the "Attribute Options" control are included in the report header.

Use Commas in Numbers: When enabled, this option will insert commas into numeric fields for every three digits.

Auto-width: When enabled, the width of each column is automatically set to be the wider of the column heading or the data contained within the column.

Widths by Field: When enabled, the width of each column established in the Attrib Options control (found in the Settings Tab) is used per field.

Fixed-width: When enabled, specify the width of each column.

Ignore Repeating Fields: When enabled, only the first occurrence of a repeating field is displayed in the report. Subsequent occurrences of the repeated field (e.g. the point description) are suppressed until a different value in the repeating field is encountered.

Totals Only: When enabled, only the total of each field is reported.

Total: Select the desired total for the Used field(s) of data.

Once the desired fields of data and reporting options have been specified, the output can be generated and manipulated using one of four tabs:

1. Report
2. MS Excel
3. Import/Export
4. Settings

Choose one of the output options:
Control Action

Sends the current report to the Standard Report Viewer command. Upon exiting the Viewer, you come back into the Report Formatter for further data manipulation as needed.

Sends the current report to a "spreadsheet" interface where it can be further exported to a variety of popular file formats. Additional information is provided in the Spreadsheet discussion.

Sends the current report to an Internet/web-ready HTML file format and displays the report using the HTML viewer that is configured on your computer.

Places the current report as a table-type of entity into the current drawing. Additional information is provided in the Table Entity discussion.

Places the current report into a special-formatted report. Additional information is provided in the Report Viewer discussion.

Report Tab Options

Spreadsheet

Export: This button has the same output options as the Export function under the Import/Export Tab. Use this option to create a variety of popular file formats, including:

- XML Format (xml)
- Text or CSV File (txt, csv)
- MS Excel "database" (xls)
- MS Access database (mdb)
- ODBC Data Sources (Misc. database formats)
For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. Some commands that can utilize this functionality are Surface Mine Reserves with the pit polylines and Underground Timing with the panel polylines.

When the polyline data is available for the GIS Links, there will be a report field called **Handle**. This Handle field is the entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report **Used** list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS Data commands from the GIS module to manage and report the data.

![Report Formatter Options](image)

**Table Entity**
The data for the Table Entity is put into a queue and the table is not drawn until the Report Formatter is closed. Then the program prompts for a location to draw the table and provides options shown above to control items such as the header names, sizes, alignments, styles, colors and layers. You can also set whether to draw the table header and totals.

**Report Viewer**

The Report Viewer option provides the ability to produce more professional looking reports that contain horizontal and vertical dividing lines and can also be exported to a variety of common report formats.

Indicate the paper size you will be printing to along with desired values for:

- Left Marging
- Right Marging
- Top Marging
- Bottom Marging

Upon specifying the desired values and clicking **OK**, the Report Viewer dialog box will display:
Controls within the report viewer allow you to:

- navigate through the page(s) of information
- refresh the report
- send the report to a printer
- switch between print layout and print preview mode
- re-configure the page setup
- export the report to other document applications
- specify the "zoom" level while displaying the report
- searching the report for a given search criteria

Several Microsoft® Excel export options are provided. You may specify a spreadsheet file to load before the export, as well as a left upper cell to start with and sheet name to use. Totals and text lines which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.
This button contains the same export options as described in the Spreadsheet discussion.

This button allows the current report to be combined with a previous report.

This button saves all the report data values as well as all the report format settings into a single *.RPT file that can be shared with others, merged with other reports or loaded at a later time.

For commands and data that conform to the ESRI Mapping Specification for DWG/DXF (MSD), this button creates an ESRI MSD-compatible report.

**Import/Export Tab Options**

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User Attrib" /></td>
<td>This option allows you to define new fields as equations based on existing fields. Additional information is provided in the User-defined Attributes discussion.</td>
</tr>
<tr>
<td><img src="image" alt="Field Options" /></td>
<td>This option allows you to further customize additional content (e.g. Date/Time, Report Name, etc) into the report header, body and/or report footer. Additional information is provided in the Field Options discussion.</td>
</tr>
<tr>
<td><img src="image" alt="Attrib Options" /></td>
<td>This option allows you to control several parameters of each field including title names, number of decimal places, etc. Additional information is provided in the Attribute Options discussion.</td>
</tr>
</tbody>
</table>

**Settings Tab Options**

**User-defined Attributes**
You can create highly customizable fields of data using parametric equations from other fields of program-generated data... all without the use of an external spreadsheet! User attributes may also have one of the several summation options just like program-generated ones. This feature makes the Report Formatter a very flexible tool for results exploration and reporting.

The summation level is defined by the "Total" pop-up list in the middle of the dialog. By default, only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted.

For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name.

**Field Options**

"Field Options" can be placed into one or more locations within the report:

- Report Header
- Report Body
- Report Footer
Select the desired location for the field and then click on the various controls to add or remove the item from the desired location or change its formatting information.

**Attribute Options**

![Attribute Options](image)

In addition to controlling the user-friendly heading text, you can also indicate totaling methods including:

- Sum
- Simple Average
- Weighted Average

When controlling the number of decimal places, the values can also be rounded up to the nearest integer level such as when earthwork volumes need to be reported to the nearest 1000. There is an option to Advance Line After the Field of the report which inserts a blank row and shifts the next attributes down to a new line in the report. To specify a particular field width, highlight/select the field and choose *Edit* to set the desired field width.

**Pulldown Menu Location(s):** -various-
**Keyboard Command:** -various-
**Prerequisite:** -none-

### Instruction Manual and Program Conventions

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

<90.0000>

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an *OSNAP* mode that is turned on by the command.
Language Localization

To run the program in another language, go to Settings->Carlson Configure->Localization Options and choose Windows Settings for the Language option.

Then set the language in Windows.

In Windows Vista, XP and earlier:
Run Start->Control Panel->Regional and Language Options. In Windows Vista, choose the language under the Formats tab. In earlier Windows, choose the language under the Regional Options tab.

In Windows 7:
Run Start->Control Panel->Clock, Language and Region. Then pick Region and Language and choose the language under the Formats tab.

There is a second Windows setup step for languages that don't use character set 1252 for English and Western languages. This second step is to run Windows Control Panel and go to the Advanced tab of Regional and Language Options and select the language. Then reboot Windows. For example, with Russian, you need to choose Russian under this Advanced tab.

After the language is set in Windows, restart Carlson to use the new language settings.

After restarting Carlson with the language setup, go to Settings->Carlson Menus->Menu Language Translation to translate the pull-down menus into the current language. This function will prompt for the source menu file to translate. For running on AutoCAD, there is only one menu file to translate which is called csXXbase.cui or .cuix where XX is the AutoCAD version. For example, for AutoCAD 2012, the menu to translate is called cs12base.cuix. For running on IntelliCAD, there is a base menu to translate and then separate menus for each module. The base menu is called icad6base.mnu for IntelliCAD 6 and icadbase.mnu for IntelliCAD 7. The menus for the modules are named after the module. For example, the survey.mnu is for the Survey module. For the IntelliCAD menus, you need to run this function multiple times to translate the multiple menus. After translating the menus, restart Carlson once more.

The language translation tables are stored in the Carlson EXEC\LANG\XX\LC.Messages folder. The XX is for the language abbreviation code. Each language has its own sub-folder with a 2 character name. There are 2 translation tables for each language called carlson-office.mo for the program prompts and carlson-office-mnu.mo for the pull-down menus.

Carlson provides tools to allow you to improve the translations by editing the source translation tables which are stored in PO files: carlson-office.po and carlson-office-menu-po. There are two methods for modifying the translations. One method is an on-line editor called POOTLE that is on the Carlson webpage, www.carlsonsw.com, under Support. Or you can use this link: http://translate.carlsonsw.com/. This system requires that you register with your name and email. Then you have access to edit the translation tables. After editing the translation table, you can update the translations within Carlson by rebuilding the MO files. To rebuild the MO files in POOTLE, choose the language then Carlson Office Products then Show Editing Functions. POOTLE will then list the translation tables carlson-office.po and carlson-office-mnu.po. Pick the MO function next to the table and save the MO file to the Carlson\EXEC\LANG\XX\LC_MESSAGES folder where XX in the language code such as FR for French.

The other translation method is a desktop editor called POEdit. This desktop editor has more features than the on-line editor which could be useful if you are doing a lot of editing. This desktop editor distributed on request. When saving a PO file in POEdit, the program automatically creates the companion MO file which goes to the Carlson\Exec\LANG\XX\LC_MESSAGES folder for running. For more instructions the POEdit desktop editor, go to the Carlson webpage under Support.

After updating the MO files, the program will pick up the new translations for command prompts. The pull-
down menus are updated separately by running the Settings->Carlson Menus->Translate Menu command. You need to select the English base menu and then the translated menu is generated using the same name as the base menu with the language name added as a suffix. For the AutoCAD platform, there is a single CUI menu to translate called CSxxBASE.CUI where xx is the AutoCAD version. For example, for AutoCAD 2010 this menu is called CS10BASE.CUI. The French translated version of this menu will be called CS10BASE-FR.CUI. For the IntelliCAD platform, there is a base menu called ICADBASE.MNU as well as menus for each of the modules such as SURVEY.MNU and CIVIL.MNU. The French translated versions of these menus will be called ICADBASE-FR.MNU, SURVEY-FR.MNU and CIVIL-FR.MNU. After generating the translated menu, load it using CUILOAD command in AutoCAD and the MENU in IntelliCAD.

POEdit with Carlson Menu

Carlson has customized and added a new Menu "Carlson" to the POEdit. If the Carlson customized EXE is installed user will be able to use this menu.

The Carlson menu consists of following commands.

1. Editor
This command let user to do the translation in a spread sheet styled dialog. The PO File is divided into separate groups or ranges for the purpose reducing the amount of string user sees when doing the translation. The Carlson Editor Range dialog allows user to select the alphabetical range of strings.

The selected range is then loaded in a user friendly spread like dialog for better editing. This also provides some filtering tools to the user to be able to focus on the strings of interest. User can select to see the all, un-translated or
translated string. Also filters the original or translated strings based on the filter key words.

An un-translated string can be auto-translated using Google translation, right click the string to be translated and select Auto-Translation to fetch the translation from Google. This will work if the CURL binary files are present to the BIN\CURL folder in POEdit installation directory.

2. Auto-Translate Using Google
Un-translated strings can be auto-translated using Google translation using this command. This will work if the CURL binary files are present to the BIN\CURL folder in POEdit installation directory. This command does not translate strings that contain special characters used in C format i.e. string with '%' or '\' characters.

3. Read TLT File
This command can be used to get the translations from TLT Files that already have translations, user is prompted to select a TLT file and the matching string will auto-translated if a translation was found.

4. Define Filter Keywords
This command is used for defining the filter keywords for the strings that user does not want to translate. For example translating only the Carlson survey strings user can choose to remove all the strings that contains mining words like drillhole, corehole, strata etc.
5. Translate using resource (RC) files
This command allows user to select SurvCE English and translated resource files and translates the matching strings between PO and English RC file is a translation was found in Translated RC file.

6. Find Matching Translations
This command can be used to search for matching translation in resource (RC) files and another PO File or currently loaded PO file by removing the defined special characters. For example if a string "OK" is already been translated it can look for all the strings like "&OK" etc and set the translation.

7. Verify Translation
This command can be used to verify if the equal number of special characters is present in the translated strings as there is in original string, to avoid user error in C format strings. For example if "OK\tCancel" is translated to "Aceptar\Canceled" this will prompt for user to correct the translation.
Patch Management

After the initial release of a major version, there are typically a few software service patches to fix errors. These service patches are delivered as update installs that contain only the updated program files. These update installs are not the full install and they designed to be installed onto an existing installation.

Check Patch Status

To see the software build that you are currently running, go to the Help->About Carlson command and look at the build number which is the date of the build. This number has six digits where the first two are the year, the next two are the month and the last two are the day. For example, a build on July 4, 2013 would have a build number of 130704.

Patch Notification

There are two ways to be notified of new patches. One way is that the program is setup by default to check the Carlson server once a week for new patches. This check is done when the Carlson program is started. If there is no update, the check routine displays a dialog reporting that the check didn't find a new patch. If there is a new patch, then the routine prompts for whether to install the update. If you choose to install the patch, the routine downloads the patch and steps through the install. You have the option to turn off the checking in the check status dialog by checking the "Never check again" toggle. If the checking is turned off, it can be turned on again by running Windows->All Programs->Carlson Software->Check For Updates.

The other method to be notified of new patches is to go to the Carlson website, www.carlsonsw.com, and go to Support->Downloads. Then select the product name from the product list. Then on the download page, there is a field for entering your email address for getting an email notification when updates are posted. This way you get notified immediately when an update is ready.

Manually Installing a Patch

There are two ways to manually install a patch. One is to run the Check For Updates function under the Windows->Programs->Carlson Software menu. This routine checks the Carlson server for the latest build version and
compares to your build version. If the server has a more recent build, the program downloads the patch and steps through the install.

The second method is to go to the Carlson website, www.carlsonsw.com, and go to Support->Downloads and select the software from the list of products. Then there is a list of the full install and the latest patch. The you can download and run the patch.exe.

To install the patch, you need Windows write permission to the program folder.

**Managing Patches Centrally**

Depending on your company administration policies, three different approaches to the central patch management can be considered:

1. Portion of the application is installed centrally, on the server, so that the files can be updated in the single central location instead of doing it on every workstation
2. Local patch downloads are disabled and instead a patch is downloaded to central location and launched on every workstation through the script
3. Local patch downloads are enforced, even if user chose to disable them manually.

Method 1: Partial central install on the server

This method involves running usual installation of Carlson product on the server as if it is a regular workstation. The installation path should be a folder which is accessible through the network share.

Next the product is installed on the workstations using the "Remote install" option:

User will then get a prompt to select the location where the program is installed on the server:

This will result in a smaller local installation with vital updatable files located centrally.

The update process is performed on the server by ether installing patch manually or running "Check for updates" from Programs menu.

Methods 2 & 3: Using Windows mechanisms to control local installation of the patches by the end-users

The setting controlling whether the local install on the user workstation is automatically checking for updates is located at the following location in registry (Carlson 2013 on IntelliCAD 7.2):

On 32-bit Windows:
HKEY_LOCAL_MACHINE\SOFTWARE\Carlson Software\SurvCADD\2013\ICAD7

On 64-bit Windows:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Carlson Software\SurvCADD\2013\ICAD7

The value name is NONET and value "1" (string) disables automatic update. Value of "0" or no value allows automatic updates.

Domain administrator can configure these settings to be changed using group policies on the domain server:
- Run "Group Policy Management" tool located in Control Panel, Administrative tools
- Navigate to your domain, Group Policy Objects
- Create new policy by right-clicking and selecting "New"
- Give policy a fitting name
- Right-click on policy and select Edit
- Right-click on Startup, select properties
- Click on Show File and copy your script (see below) into the folder which opens
- Click "Add" and select the script you copied

Other methods for running scripts on startup or login will work as well, as long as they are configured to run with administrative rights.

Save the following snippets into batch file (.bat or .cmd) and place then where your launching setup is looking for it.

To re-enable automatic check for updates (for 32-bit Windows):
reg delete "HKLM\Software\Carlson Software\SurvCADD\2013\ICAD7" /f /v NONET

To disable automatic check for updates (for 32-bit Windows):
reg add "HKLM\Software\Carlson Software\SurvCADD\2013\ICAD7" /f /v NONET /t REG_SZ /d 1

Patches are delivered using InstallShield PackageForWeb tool. These packages can be installed interactively by user as long we they are launched by a script with Administrative rights. User interaction with patching process can be controlled in the following manner.

To minimize interaction, but still provide user with information on patching progress, please use the following switches:
Patch_file.exe -s -a minimal

To avoid any interaction, resulting in unconditional delivery of the patch as needed, please use the following switches:
Patch_file.exe -s -a stealth

---

License Agreement

Copyright 1992-2012 Carlson Software All Rights Reserved

CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using the SOFTWARE. Using this SOFTWARE indicates that you have accepted its terms and conditions.
Carlson 2013

END-USER LICENSE AGREEMENT FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the software accompanying this EULA, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising your rights to use the SOFTWARE, you agree to be bound by the terms of this EULA. If you do not agree to the terms and conditions of this EULA, you may not use the SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS EULA, DO NOT INSTALL OR USE ANY PART OF THE SOFTWARE.

Carlson Software, Inc., referred to as "LICENSOR", develops and/or licenses proprietary computer programs and sells use licenses for such proprietary computer programs together with or apart from accompanying copy-
End User desires to obtain the benefits thereof and, in return for which, is willing to abide by the obligations and fee agreements applicable to LICENSOR's use licenses in LICENSOR's proprietary computer programs.

For good and valuable consideration, including but not limited to license grant in accordance with this Agreement by LICENSOR to End User's covenant regarding LICENSOR's proprietary rights, LICENSOR agrees to permit End User to utilize materials representing LICENSOR's product or products subject to the following terms and conditions:

1. License Grant: Subject to the terms, conditions and limitations of this EULA, LICENSOR hereby grants End User a personal, limited, non-exclusive, non-transferable, license to utilize the Software Product you have purchased. The license granted in this EULA creates no license, express or implied, to any other intellectual property of Licensor, except for the specific Software Product which they have lawfully purchased from LICENSOR.

This EULA grants you the following rights: You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a portable computer.

Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

2. Exclusive Source. End User shall obtain all LICENSOR authorized product materials through LICENSOR or LICENSOR'S authorized representative and no other source. LICENSOR authorized product materials include, but are not limited to, manuals, license agreements and media upon which LICENSOR's proprietary computer programs are recorded. End User shall make no copies of any kind of any of the materials furnished by LICENSOR or LICENSOR's authorized representative, except as specifically authorized to do so in this EULA.

End User is not entitled to make archival copies of those portions of LICENSOR's product(s) that are provided on a machine readable media.

3. Proprietary Rights of Licensor. End User agrees that LICENSOR retains exclusive ownership of the trademarks and service marks represented by its company name and logo and all of the documentation and computer recorded data related thereto. End User also agrees that all techniques, algorithms, and processes contained in LICENSOR's computer program products or any modification or extraction thereof constitute TRADE SECRETS OF LICENSOR and will be safeguarded by End User, but in no event shall End User exercise less than due diligence and care in accordance with the laws of the country of purchase and International Law, whichever operates to best protect the interests of LICENSOR. End User shall not copy, reproduce, re-manufacture or in any way duplicate all or any part of LICENSOR products WHETHER MODIFIED OR TRANSLATED INTO ANOTHER LANGUAGE OR NOT, or in any documentation, or in any other material provided by LICENSOR in association with LICENSOR's computer program products regardless of what manner of storage and retrieval the product exists, except as specified in this Agreement and in accordance with the terms and conditions of this Agreement which remain in force. End User agrees that in the event End User breaches this EULA, End User will be liable for damages as may be determined by a court of competent jurisdiction.

4. Restrictions. End User's rights and obligations under this EULA are nonexclusive and personal in nature, and the intellectual property Licensor grants to End User is subject to applicable law other than bankruptcy law. End User may not transfer or assign the SOFTWARE, rights under this EULA or accompanying user documentation, or any updates of the SOFTWARE which may be provided under this EULA, to a third party unless End User receives written consent from Licensor at least 30 days prior to the completion of transfer. Licensor reserves the right to deny transfer or assignment if, in its sole discretion, Licensor determines the transfer not to be a necessity. Whether or not a transfer or assignment is allowed shall be determined in Licensor's sole discretion after taking into consideration certain factors to find the existence of a necessity including, but not limited to, merger or
acquisition of an entity, complete asset acquisition, change of control, severe economic hardship, severe loss of
human resources or significant loss in business divisions, or winding down of entity affairs.

If Carlson consents to a transfer, such transfer shall be allowed only as a one-time permanent transfer of this
EULA and Software to another end user, provided the initial End User retains no copies or previous versions of
the Software. The transfer must include all of the Software, including all component parts, any media and printed
materials, any upgrades, this EULA, and any associated license key. The transfer may not be an indirect transfer,
such as a consignment, rental or lease. No corresponding Maintenance Agreement rights shall transfer with the
SOFTWARE transfer to the subsequent end user. Prior to the transfer, the subsequent end user receiving the
Software from the initial End User must agree to all terms of this EULA, with the added condition that no further
transfers to third parties are permitted for any reason whatsoever, and shall agree to the terms and conditions of a
new Maintenance Agreement with Licensor.

You may not reverse engineer, decompile, or disassemble the SOFTWARE or alter the images utilized in the
SOFTWARE and user documentation. The SOFTWARE PRODUCT is licensed as a single product. Its component
parts may not be separated for use on more than one computer. You shall communicate to any individual user in
your facility that they are bound by the restrictions of this license agreement may not copy or alter the SOFTWARE
for use outside End User's facilities.

Upgrades. If you purchase an upgrade of a SOFTWARE PRODUCT and you use it on different machine from one
where upgraded SOFTWARE PRODUCT was used, use of original SOFTWARE PRODUCT must be discontinued
and confirmed within 30 days. If such use is not discontinued, it is a material breach of this EULA and LICENSOR
shall be entitled to all remedies available to it under this EULA, and under the laws of Kentucky, USA.

5. Security Mechanisms. Licensor and its affiliated companies take all legal steps to eliminate piracy of
their software products. In this context, the Software Product may include a security mechanism that can detect the
installation or use of illegal copies of the Software Product, and collect and transmit data about those illegal copies.
Data collected will not include any customer data created with the Software. By using the Software Product, you
consent to such detection and collection of data, as well as its transmission and use if an illegal copy is detected.
Licensor also reserves the right to use a hardware lock device, license administration software, and/or a license
authorization key to control access to the Software. You may not take any steps to avoid or defeat the purpose of any
such measures. Use of any Software without any required lock device or authorization key provided by Licensor is
prohibited.

6. Audit Rights. End User agrees that LICENSOR has the right to require an audit (electronic or otherwise)
of the LICENSOR Materials and the Installation thereof and access thereto. As part of any such audit, LICENSOR
or its authorized representative will have the right, on fifteen (15) days' prior notice to End User, to inspect End
User's records, systems and facilities, including machine IDs, serial numbers and related information, to verify
that the use of any and all LICENSOR Materials is in conformance with this Agreement. End User will provide
full cooperation to enable any such audit. If LICENSOR determines that End User's use is not in conformity with
this EULA, End User will obtain immediately and pay for a valid license to bring End User's use into compliance
with this EULA and other applicable terms and pay the reasonable costs of the audit. In addition to such payment
rights, LICENSOR reserves the right to seek any other remedies available at law or in equity, whether under this
Agreement or otherwise.

7. Warranty. THE PRODUCT IS PROVIDED "AS IS" WITH ALL FAULTS. TO THE MAXIMUM EXTENT
PERMITTED BY LAW, LICENSOR HEREBY DISCLAIMS ALL WARRANTIES, WHETHER EXPRESS
OR IMPLIED, INCLUDING WITHOUT LIMITATION IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, AND WARRANTIES THAT THE PRODUCT IS FREE OF
DEFECTS AND NON-INFRINGEMENT, WITH REGARD TO THE SOFTWARE, AND THE ACCOMPANYING
WRITTEN MATERIALS. YOU BEAR ENTIRE RISK AS TO SELECTING THE PRODUCT FOR YOUR
PURPOSES AND AS TO THE QUALITY AND PERFORMANCE OF THE PRODUCT. THIS LIMITATION
WILL APPLY NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. In any
event, LICENSOR will not honor any warranty shown to exist for hich inaccurate or incorrect identifying data has
been provided to LICENSOR. The product(s) provided are intended for commercial use only and should not be utilized as the sole data source in clinical decisions as to levels of care.

8. LIMITATION OF LIABILITY. EXCEPT AS REQUIRED BY LAW, LICENSOR AND ITS DISTRIBUTORS, DIRECTORS, LICENSORS, CONTRIBUTORS AND AGENTS (COLLECTIVELY, THE "LICENSOR GROUP") WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES ARISING OUT OF OR IN ANY WAY RELATING TO THIS EULA OR THE USE OF OR INABILITY TO USE THE PRODUCT, INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, LOST PROFITS, LOSS OF DATA, AND COMPUTER FAILURE OR MALFUNCTION, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF THE THEORY (CONTRACT, TORT OR OTHERWISE) UPON WHICH SUCH CLAIM IS BASED. THE LICENSOR GROUP'S COLLECTIVE LIABILITY UNDER THIS AGREEMENT WILL NOT EXCEED THE GREATER OF $500 (FIVE HUNDRED DOLLARS) AND THE FEES PAID BY YOU UNDER THIS LICENSE (IF ANY).

9. Update Policy. LICENSOR may, from time to time, revise the performance of its product(s) and in doing so, incur NO obligation to furnish such revisions to any End User nor shall it warrant or guarantee that any revision to the SOFTWARE will perform as expected by the End User on End User's equipment. At LICENSOR's option, LICENSOR may provide such revisions to the End User.

10. Customer Service. Although it is the LICENSOR's customary practice to provide reasonable assistance and support in the use of its products to its customers, LICENSOR shall not be obligated to any End User to provide technical assistance or support through this Agreement and may at LICENSOR's sole election charge a fee for customer support.

11. Termination of End User License. If any one or more of the provisions of this Agreement is breached, the license granted by this Agreement is hereby terminated. In the event of such termination, all rights of the LICENSOR shall remain in force and effect. Any protected health information data of End User maintained on LICENSOR’S data base shall upon reasonable notice to End User and at the discretion of LICENSOR may be destroyed.

12. Copyright. The SOFTWARE (including, but not limited to, any images, photographs, animations, video, audio, music and or text incorporated into the SOFTWARE), and all intellectual property rights associated with it, whether exists in a tangible media or in an electronic image media is owned by LICENSOR and is protected by United States copyright laws and international treaty provisions and all other commonwealth or national laws. LICENSOR reserves all intellectual property rights in the Products, except for the rights expressly granted in this Agreement. You may not remove or alter any trademark, logo, copyright or other proprietary notice in or on the Product. This license does not grant you any right to use the trademarks, service marks or logos of LICENSOR or its licensors. You may not copy any user documentation accompanying the SOFTWARE.

13. Injunctive Relief. It is understood and agreed that, notwithstanding any other provision of this Agreement, LICENSOR has the unequivocal right to obtain timely injunctive relief to protect the proprietary rights of LICENSOR.

14. Entire Agreement. This EULA constitutes the entire agreement between the parties and supersedes any prior agreements. This EULA may only be changed by mutual written consent.

15. End User Agreement Acknowledgment. The End User hereby accepts all the terms and conditions of this Agreement without exception, deletion, alteration. End User acknowledges they are authorized to enter this agreement on behalf of any organization for which the license is sought. Any unauthorized use of LICENSOR products will be considered a breach of this Agreement, subject to liquidated damages and otherwise unlawful and willful infringement of LICENSOR's trade secrets and/or proprietary products.

16. Payment and Refund Policy. The use of the SOFTWARE herein is deemed a commercial use and under the terms of this license agreement End User shall not be entitled to any refund of purchase price. End User agrees
to pay all user fees promptly. LICENSOR is authorized by End User to suspend any further access to SOFTWARE in the event fees are not fully paid. End user entity shall promptly pay any and all access and use charges incurred regardless of the end user. End user is responsible for protecting any pass word and user identity supplied to End User.

17. Loss/Theft/Misuse. End user shall promptly report to LICENSOR the theft or other loss of any pass word and/or user identity required to access SOFTWARE. LICENSOR shall not be responsible for maintaining the integrity of End User data in the event that end user's data base is accessed and/or altered by an unauthorized end user due to the failure of licensed End User to protect its password or user identity. End User shall be responsible for any costs incurred by LICENSOR due to the negligence or reckless disregard of End User's failure to protect its password or user identity.

18. Civil/Criminal Investigation. End user shall fully cooperate with LICENSOR and or any person authorized by LICENSOR (including local, state, or federal law enforcement officials) to investigate any alleged theft, misuse or unauthorized use of SOFTWARE or data related thereto.

19. U.S. Government Restricted Rights. The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (b)(1)(ii) and (c) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable.

20. Governing Law. This EULA shall be governed and construed in accordance with the laws of the Commonwealth of Kentucky, USA.
General Commands
File Menu

All the Carlson module menus share seven of the same pull-down menus which are:

1. File
2. Edit
3. View
4. Draw
5. Inquiry
6. Settings
7. Points

These menus (along with Window and Help) form a "core" group of commands which can be accessed regardless of the Carlson module that is being used. The common pull-down menus contain general commands that are applicable within all the modules. Many of these commands are AutoCAD or IntelliCAD commands which are described in your CAD Reference manual. The Carlson commands located in the common pull-down menus are explained in the next sections.

Note:

- Within a module, other pull-down menus (typically three or four) are often specific to the module but certain commands (e.g. Triangulate & Contour) may be found in several modules.

The set of commands varies slightly between the CAD platforms and versions.

New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. The first dialog for the New command, called Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right.

The template file (.DWT) that you use will depend on the version of AutoCAD or IntelliCAD that you are running. For AutoCAD 2000-2002, the Carlson template file is carlson02.dwt. For AutoCAD 2004, it is carlson04.dwt. For
AutoCAD 2005, it is carlson05.dwt. For AutoCAD 2006, it is carlson06.dwt. And for AutoCAD 2008, the Carlson template file is carlson08.dwt. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box, or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in one of the Carlson .DWT template files, depending on the measurement system you’ve chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.

**English:** This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

**Metric:** This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.

The New command creates a new drawing, using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views.
Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

Remember that there are two methods that you can use to work on a Carlson drawing. One is the New command, and the other is the more generic Open command. If you need to open an existing drawing, use Open, also found in the File menu, and then choose an existing file name.

Pulldown Menu Location: File
Keyboard Command: new
Prerequisite: None

Drawing Cleanup

The Drawing Cleanup dialog box allows you to perform many functions that fix common errors, and it removes unnecessary data found in many drawing files. It also converts incompatible data into useful entities. This command offers many filters that audit the drawing file and allows you to select which options and settings you want to use. A report of the cleanup results will be displayed upon completion. Always save your file when the drawing cleanup routine is complete.

Set UCS to World Coordinates

This sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson works exclusively in the world coordinate system and there is no way to change this setting. In CAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, click this on to restore the UCS.

Convert Architectural Inches Units To Decimal Feet

Drawings are sometimes in architectural units, i.e. inches, when the unit of measurement was intended to be in feet. This routine will change the units from inches into feet and then scale the drawing by 1/12.
Import Xrefs To Current Drawing
This routine allows you to import any 'found' external reference files (Xrefs) into the current drawing. If the path is not found, the Xref file will not be brought into the drawing. To set the Path for any unfound Xrefs, run Import Xref to Current Drawing under File.

Remove Layers With No Entities
Drawings work with a "BYLAYER" concept meaning that layer definitions define the drawing. For example, the layer named EOP might be used to display polylines at the Edge Of Pavement in the drawing. Many times extra layers get defined by a user but not used to display any objects. This function removes any layers defined in the drawing that are not being used.

Rename Layers With Wildcards
Layers with wildcard characters such as "*" can interfere with Carlson layer matching functions. This routine renames layers by replacing any wildcard characters with an underscore "_".

Remove Unused Blocks, Linetypes and Styles
This functions removes this unused information from the drawing.

Remove Zero Length Linework
This function seeks out and removes any linework definition that have zero length. Point nodes are not removed.

Remove Duplicate Linework
This function finds any duplicate linework in the drawing and removes all but one set.

Remove Duplicate Points
This function searches the drawing (but not the .CRD file) for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set to the right. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance.

Remove Overlapping Polyline Loops
Polylines that completely overlap themselves are broken into two different polylines.

Join Linework With Same Endpoint
This function finds common endpoints on linework on common layers with common elevations and joins the linework into a continuous polylines. This is very helpful for future selection sets.

Convert Splines, Multilines and Regions Into Polylines
Some CAD applications utilize Spline Object Definitions and Regions, Carlson utilizes basic polyline/polygon definitions. This function finds any Splines and/or Regions defined in the drawing and re- defines them as simple polylines or polygons.

Convert Lines, Arcs, Circles, Ellipses, 3DFaces and Solids Into Polylines
By converting Lines, Arcs, Circles, Ellipses, 3D Faces, and Solids into Polylines, you can use the variety of Polyline commands available in Carlson.

Convert LDD-AEC Contours and Points Into Carlson Format
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re- defines them as simple 2D polylines retaining their elevation values.

Convert Entities With Extrusion To World Coordinates
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re- defines them as simple 2D polylines retaining their elevation values.
**Erase Blank Text Entities**
This function removes any text boxes defined in the drawing that are not being used.

**Erase Hatch Entities**
Carlson offers many hatch display options, however hatch entities have no 3D value. This function removes all hatch entities in the original drawing to help reduce the size and clutter of the drawing file.

**Remove Arcs From Polylines - Offset Cutoff**
This function replaces arcs in polylines with a series of short chord segments. The purpose is to prepare the polylines for modeling since arcs need to be converted into segments to be part of the triangulation model. The density of chord segments is controlled by the offset cutoff. This cutoff represents how much the polyline can move horizontally. A smaller cutoff will result in more chord segments. The option for 3D Only controls whether only polylines at zero elevation or both zero and elevated polylines get processed. Sometimes you may want to leave the arcs in zero elevation polylines when these polylines represent road alignments and are not part of the surface model.

**Reduce Polyline Vertices - Offset Cutoff**
This function utilizes a pre determined offset amount and removes unnecessary polyline vertices that fall within the offset amount.

![Before Reduce Polyline Vertices](image1.jpg)
![After Reduce Polyline Vertices](image2.jpg)

**Set Elevations Outside Range to Zero and Elevation Range**
This function comes with a "Scan DWG" option that audits the elevation range in the drawing file. Once the minimum and maximum elevation range has been set, manually or by a scan, all objects that fall outside the set range are moved to elevation zero. All objects at zero elevation do not contribute to the 3D model.

**Entities To Process...**
This allows you to run the command for the entire drawing or for a selected set.

**Default**
This allows you to return to the Carlson Drawing Cleanup default settings.

**Final Report**
This example report displays the results of drawing cleanup. Like all reports in Carlson, this report can be saved to a text file, sent directly to your printer, or pasted onto the screen ad text entities.
Drawing Explorer

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing and are tracked in DrawingName.ini. If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will not display any files. The Drawing Explorer will also not show any data files if the drawing is not saved. Once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files. Drawing Explorer helps manage drawing-related data.

The Drawing Explorer is shown as a docked dialog on CAD window with files shown as a tree view under different categories. These file categories are fully customizable and can contain multiple file types. The drawing name is shown as root of the tree view with file categories as its children. The file types associated with a category are listed as children of that category. The data files used with the drawing are listed under respective file type or in subfolders of the project folder specified using the Set Project/Data Folders command. The data files used as current files are shown with bold font.
The Drawing Explorer allows user to view/manage data files associated with the currently opened drawing by allowing him to add, remove, report, and change directory of these files. A mouse right-click can also be used to add and remove any data file/file type/file category from the Explorer.

The Add button allows adding a file under the category or file type that is currently selected in the tree view. If the drawing file name is selected, the user is allowed to add any type of file to the Explorer and file will be added to the corresponding category.  

Removes the selected file(s) along with any "child" (subordinate) files from the drawing. The underlying file(s) are not physically deleted or removed from the hard-drive, they are merely removed from the Drawing Explorer.  

Creates a report through the Report Formatter Options dialog box. The Report Formatter can be used to move to the Available entries on the left to the Used area on the right. When coupled with the Up/Down options to control the order, highly customized reports can be generated and saved for subsequent use. Click the Display to obtain the report.  

The Change Directory option allows you to instruct Carlson Software to re-direct the location for files from an old folder location to a new folder location. This option is helpful if project data files are manually moved to a new folder location.  

The Settings button allows you to create Categories of file types and assign data files to a particular Category and assign how project data files are presented in the Project Explorer.  

The Refresh button re-reads the current Project file along with the various Drawing file settings and updates the Project listing appropriately. Exits from the Project Explorer command.  

The option to show preview allows user to see the preview of currently selected data file in a small preview window at the bottom of the Explorer dialog.
The List Data Files settings are used in Project Explorer to list files according to drawing files in the project of by project.

**Right-Click Command Execution:** The Drawing Explorer also allows execution of functions associated with a file type. Right-clicking on any file type or data file brings up menu for the commands associated with that file. If the command requires the file during execution, the selected data file will be used to run that command. For example, in the figure below, `Example1.grd` will be used to run the Draw 3D Grid File command and the program will not prompt for the grid file to be drawn.

**Pulldown Menu Location(s):** File > Project

**Keyboard Command:** dwgxplore

**Prerequisite:** None

Chapter 2. General Commands 61
**Project Explorer**

This tool is used for management of a complete project. A project can contain multiple drawings, and each drawing within that project can contain multiple associated data files.

Think of the Project Explorer as the trunk of the hierarchical tree structure that develops into a project as illustrated below:

As you work in a drawing, Carlson keeps track of the files that you create (such as TIN and coordinates files). These are related to the drawing and you can use the Drawing Explorer to manage them. The Project Explorer is used to manage multiple drawings. In the following illustration, two views of the same Project are displayed:

- *By Drawing* - shown on the left.
- *By Project* - shown on the right.

Control
- Action
  - Adds a drawing and its data file(s) into the project.
Removes the selected file(s) along with any "child" (subordinate) files from the project. Note that removing a data category or file at the "project" level also removes the category or file at the "drawing" level.

Creates a report through the Report Formatter Options dialog box. The Report Formatter can be used to move to the Available entries on the left to the Used area on the right. When coupled with the Up/Down options to control the order, highly customized reports can be generated and saved for subsequent use. Click the Display to obtain the report.

The Change Directory option allows you to instruct Carlson Software to re-direct the location for files from an old folder location to a new folder location. This option is helpful if project data files are manually moved to a new folder location.

The Settings button allows you to create Categories of file types and assign data files to a particular Category and assign how project data files are presented in the Project Explorer.

The Refresh button re-reads the current Project file along with the various Drawing file settings and updates the Project listing appropriately.

Exits from the Project Explorer command.

Displays the on-line help.

**Project Explorer Controls**

The project history/log report file can be generated using Report button. The Project Explorer tracks all the data files used with the project. The report function also uses the data file information logged with the Carlson Data Depot. The program allows you to report all revisions or only the last commit on all project files from Carlson Data Depot. The information reported include project file, drawing name, file category, file path, file name, file type, date, time, size, revision, author, date committed and commit message along with project properties (i.e. company name, project name etc). Here’s a sample report.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Carlson</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Data Depot</td>
</tr>
<tr>
<td>Project Description</td>
<td>Date Depot Description</td>
</tr>
<tr>
<td>Project Due Date</td>
<td>Jun 11, 2010</td>
</tr>
<tr>
<td>File Name</td>
<td>File Type</td>
</tr>
<tr>
<td>EXAMPLE1</td>
<td>Centerline Files (.cl)</td>
</tr>
<tr>
<td>EXAMPLE1</td>
<td>Coordinate Files (.crd)</td>
</tr>
<tr>
<td>EXAMPLE1</td>
<td>Grid Files (.grd)</td>
</tr>
<tr>
<td>NEWTRI</td>
<td>Triangulation Mesh Files (.tin)</td>
</tr>
<tr>
<td>ROADS</td>
<td>Profile Files (.pro)</td>
</tr>
</tbody>
</table>

Linking a project to the Carlson Data Depot requires that you properly configure the Data Depot through the Set Project/Data Folders command and then open a drawing and assign it to a Project (.PRJ) file. If a project is not linked to the Data Depot, a question mark is overlaid on all the files and folders under that project as shown:
To link a project to the Data Depot, perform the following steps:

1. Right click on the Project File name (the "trunk" of the Project Explorer tree) and select Link to Data Depot command:

   ![](image1.png)

2. This will bring up the "Project to Link to" window. The window you see depends upon whether you are using SVN or ProjectWise as your Data Depot Repository.

   (a) **SVN**: This window shows the existing projects under the repository, if any. A new project folder can be created under Carlson Data Depot Repository by using the Create Folder button. Sub-folders can be
created by using the Create Folder button while top folder selected. Select the folder you want to create the project under and click OK:

(b) **ProjectWise - Step 1:** This window shows the existing projects under the repository, if any. A new project folder can be created by right clicking on the ROOT entry of the repository tree:
(c) **ProjectWise - Step 2**: Name the new project, select it from the list and click the OK button.

3. This will prompt you to Add to Data Depot window where you can enter a log message to identify what you are doing. This information will be added to the history log. Click OK to start adding files to the project repository:
4. A status window will appear showing the message for files that have been tasked to be added to the repository:

5. Once the files are linked to the Data Depot, the status/icon in the tree view is changed:

When new files are created inside the project, they are shown as not linked to the Data Depot (using the question mark icon) and can later be linked to the Data Depot by right clicking and using the Add to Data Depot command.
Data Depot File Status

The following shows the icons used in the Project Explorer tree for representing the state of files in the Data Depot:

Data Depot Commands

Add Existing Files: Allows the user to select an existing data file from local storage which will be added to the project and the Data Depot. The data file will be associated (placed under) the currently selected drawing.

Remove: Removes the selected file from the project without removing it from the Data Depot.

Properties: Brings up the system file properties dialog.

Add to Data Depot: Incorporates the selected file(s) into the Data Depot.

Update from Data Depot: Gets the last committed version of the selected file(s) from the Data Depot.

Update XREF's: Gets the last committed version of any XREF files associated with the selected drawing.

Commit to Data Depot: Incorporates locally modified/locked file(s) that are already part of the Data Depot into the Data Depot.

Purge Local Copies: Deletes the selected file from the local storage leaving it in the Data Depot and the project. The local copy can be restored later by using the "Update from Data Depot" command.

Edit Mode (Lock): Locks the selected file(s) for local editing and prevents others from modifying the file(s). If the drawing or data file is newer in the Data Depot than on local storage this command will be disabled.

Read-Only Mode (Unlock): Unlocks the selected file(s) so that they may be edited by others.

History: Displays the history log of changes made to the selected file.

Clean (project level only): "Cleans" the project of items that don't exist in both the Data Depot and local storage.

Once the project has been added to the Data Depot, it can be quickly updated or accessed by other users and be ready for use via the Get Project from Data Depot command:
Notes on locking/unlocking project files when using Subversion repository

Subversion locking of the file is specific to the specific working folder - the file in a particular checked out set of files. Same user working on another copy of file in different folder or on different computer will not own the lock. External subversion clients have additional lock functionality which not exposed through Carlson Data Depot interface for purposes of simplicity. These clients will have options for stealing lock (placing the lock on file already locked at different location or by different user) and forcing lock (unlocking a lock placed at different location or by different user). In a productive collaborative environment such design allows on one hand to prevent accidental editing of the file which is locked by another user and causing a situation when one of the users has to abandon his changes, but on the other it allows to move forward if file is locked accidentally and file needs to be re-locked elsewhere.

In the case when this design is not sufficiently strict, it is possible to override this behavior by implementing server-side hooks which change the default behavior. Here is the example of pre-unlock script for VisualSVN which limits lock overrides to original user or to user called Administrator:

```batch
@echo off
setlocal
set REPOS=%1
set RPATH=%2
set USER=%3
set SVNLOOK=%PROGRAMFILES%\VisualSVN Server\bin\svnlook.exe
set TMPFILE=%temp%/lockinfo

rem Creating a temporary file with output of the lock, filtering everything except owner out
''%SVNLOOK%'' lock ''%REPOS%'' ''%RPATH%'' | find ''Owner'' > %TMPFILE%
rem Parsing the file looking for owner name only
FOR /F ''usebackq tokens=2'' %%A IN (%TMPFILE%) DO set LOCK_OWNER=%%A

del %tmpfile%

if ''%LOCK_OWNER%''=='''' goto GOOD
if ''%LOCK_OWNER%''==''%USER%'' goto GOOD
rem Only Administrator can break the lock
if ''Administrator''==''%USER%'' goto GOOD

echo ''Permission denied! Ask Administrator for assistance'' 1>&2
endlocal
exit 1

:GOOD
endlocal
exit 0
```

Simply paste this script into the hook window by going into VisualSVN Server Manager, right-clicking over repository, All Tasks, Manage Hooks, double-click pre-unlock hook.

**Pulldown Menu Location(s):** File > Project

**Keyboard Command:** prjxplore

**Prerequisite:** None

*Chapter 2. General Commands* 69
Get Project from Data Depot

The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and manage the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Once a project has been successfully registered with the Data Depot using the Project Explorer, it can be retrieved through the Data Depot for subsequent editing.

Subversion Example:

![Subversion Example](image)

Continue below to the "Select the Project" section.

ProjectWise Example:

![ProjectWise Example](image)

For ProjectWise the "Select Included Data Type Categories" dialog will appear. Here the user can select which types of files to download from the repository. A special category "Non Carlson" is used to determine whether files not
associated with Carlson Software should be downloaded or not (e.g. Word .DOC documents or Microstation .DGN files). If the user wants even more control over what files are downloaded, say at the drawing level, he/she can use the "Clear All" button to deselected all categories. In this case, only the directory structure plus the Project File (.PRJ) will be downloaded. This allows the user to select which drawings they want to download from the repository directly from the Carlson Project Explorer.

Selecting the Project:

Select the project you would like to open and click OK. Unless you have selected "Use Automatic Project Folder Name" (see Set Project/Data Folder for more information), you will be prompted to identify a "working" folder where the checked-out copies of your project files will reside:

Identify the destination folder location and click OK. The checked-out copies of the project files will be placed into
the specified folder at which point further editing can begin.

**Pulldown Menu Location:** File > Project  
**Keyboard Command:** get_prj_from_depot  
**Prerequisite:** A properly installed, configured and support content management system

## Layout Manager

The Layout Manager is a docked dialog that displays the contents of a Layout Set. Layout Sets (.set files) contain information on layouts that come from a single or multiple drawings. Once you build a layout set, the Layout Manager facilitates printing via AutoCAD's PUBLISH functionality.

The Layout Manager contains two sections. A Treeview, which displays the items of the Layout Set. Items are the root node, which is the topmost node representing the Layout Set. Subsets, which act as folders and can contain Layouts and additional Subsets.

The bottom section contains a grid view, which will display built-in and custom properties of the selected Layout Set, Subset or Layout item. The first column shows the property name, and the second column displays its value. Some properties are read-only and are calculated by the Layout Manager.

- **New:** Use the New button to create a new empty Layout Set. You can also specify an existing layout set to use as a Template. If a Template is specified, only the Subsets (folders) structure will be copied to your new Layout Set. This is convenient is you have a standardized Subset structure to use for all Layout Sets.

- **Open:** Use the Open button to open an existing Layout Set. Only one Layout Set is allowed open per session. If a Layout Set is currently open in the Layout Manager, you will be prompted to save any changes if necessary.

- **Save:** Use the Save button to save your current Layout Set file. Layout Sets are saved as .set files.

- **Save As:** Use the Save As button to save a copy of an existing Layout Set file with a new name.
Print: Use the Print button print all checked layouts using AutoCAD's Publish functionality. All Subsets and Layouts in the Layout Manager contain a checkbox. If the Subset or Layout is checked, it will be included when the print command is run. When a user checks a Subset, all the child items of that Subset are checked. Similarly, when a Subset is unchecked, all the child items of that Subset are unchecked.

Insert Table: Use the Insert Table button to insert a Table of Contents. This feature allows you to draw a Table containing all the layouts of the Layout Set, including their file name, drawing name, page number, etc.

Use the Set Table Columns button to define which columns are to be displayed in the Layout Set table. Toggle the Use Table Entity to insert the table as a block, or leave it unchecked to draw each row as an individual block.

You can edit the Label column, which will be displayed as the column header in your table. The Width and Text Alignment can also be set for each column.

Exit: Use the Exit button to exit and close the Layout Manager.

Add Subset: Use the Add Subset button to create a new Subset folder under the selected Layout Manager item.

Add Layout: Use the Add Layout button to add a Layout to the current Layout Set file in the selected Subset or root of the Layout Set. Layouts may be selected from the current drawing, or from another drawing on your computer or network.
**Move Up:** Use the Save As button to move the selected Layout (or Subset and child Layouts) above the previous sibling item.

**Move Down:** Use the Save As button to move the selected Layout (or Subset and child Layouts) below the next sibling Subset or Layout.

**Move In:** Use the Move In button to move the selected Layout (or Subset and child Layouts) under the next sibling Subset.

**Move Out:** Use the Move Out button to move the selected Layout (or Subset and child Layouts) above the selected parent Subset.

**Remove Item:** Use the Remove Item button to remove the selected Layout (or Subset and child Layouts).

**Custom Properties:** Use the Custom Properties button to Add, Edit or Remove custom properties to a Layout, Subset or Layout Set.

Select the appropriate tab to add a custom property. Then use the Add, Edit or Remove buttons to edit properties for the selected item type.

**Pulldown Menu Location:** File > Plot

**Keyboard Command:** layoutmgr

**Prerequisite:** None

---

**Import LandXML File**

The Import LandXML File routine provides a mechanism where land-based data from other software applications (including Carlson Software) can be brought into a project and used for analysis and/or design purposes. To import a LandXML file, a series of dialog boxes are presented:

**Select LandXML File:** Specify the name of a LandXML file you wish to import.
**LandXML Units:** Indicates the Units of Measure associated with the incoming LandXML file (see the Unit Differences item below).

**Point Protection:** When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those that already exist in the drawing. When disabled, existing point data in the project is updated with the values from the LandXML file.

**Destination File Method:** This option allows you to indicate how the incoming data file(s) are named as they are imported.

**Load Surfaces into Surface Manager:** When enabled, this option will automatically add surface model (TIN) data into the Surface Manager and graphically represents (draws) the surface model/contours according to the current settings found in the Triangulate & Contour command.

**Use Old FLT Triangulation File Format to Import Surface Data:** When enabled, the older ASCII-based Carlson *.FLT file format will be used in place of the newer and more efficient *.TIN file format.

**Save All Existing Ground Profiles from One Centerline to the Same File:** When enabled, collections of existing ground profiles associated with a particular centerline are combined into a single *.PRO file.

**Change Directory:** This option allows you to adjust the folder location where the new data files will be written.

**Import from LandXML:** Enable or disable various entries that should used to produce the data files found within the LandXML file.

**Unit Differences:** If the Units of Measure specified in the LandXML file are different than those found in Drawing Setup, you will be prompted for a course of action.
Manning's "n": If you are importing sewer data from a LandXML file and if the LandXML file does not carry Manning's "n" values, you will be prompted to specify a default Manning's "n" value for all incoming sewer entities that don't already have a Mannings "n" value.

Import Structures: If you are importing sewer data from a LandXML file and structure values specified in the LandXML file do not exist in the Structure Library, you will be prompted to indicate the structure(s) that should be imported into the Structure Library. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple structures at the same time.

Skip Invisible Triangles: This option applies to importing TIN surfaces from Civil 3D. When this option is active, triangles marked by Civil 3D as invisible or excluded are not imported.

Note:

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don’t have to own or use the CAD or software product used by your data provider).

Pulldown Menu Location(s): File > LandXML

Keyboard Command: landxml import

Prerequisite: A LandXML file to import

Import Google Earth File

The Import Google Earth File command allows you to insert a KML (Keyhole Markup Language or alternatively a KMZ) file of points (KML Placemark), polylines (KML Path) and closed polylines (KML Polygon) into your drawing. Throughout this discussion, KML will be used to also describe KMZ files unless explicitly noted.
**Import Lines and Polygons:** When this option is selected, KML Path and Polygon entries will be placed into the drawing as open or closed polylines, respectively.

**Import Points:** When this option is selected, KML Placemark entries will be placed into the drawing and active coordinate file.

**Point Protect:** When enabled, existing points in the active coordinate file will not be over-written.

**Use Folders as Layers:** When enabled, KML Folder entries will be used to create layer names in CAD and the supported KML options described above will be placed onto the layer that conforms the the Folder to which they belong.

**Default Layer:** The supported KML options described above that are not contained in a KML folder will be placed into the specified layer.

**Note:**

- Placemarks, paths or polygon entries that have an altitude value specified will be imported at the proper “Z” elevation in the CAD drawing.
- KML or KMZ files can be specified for the import process.

**Prompts**

**Google Earth File to Read:** *Select a previously saved KML or KMZ file.*

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

**Pulldown Menu Location:** File > LandXML/RoadXML/Google Earth

**Keyboard Command:** kmlread

**Prerequisite:** A KML or KMZ file with Placemark, Path and/or Polygon information, an active coordinate file with an established projection zone through Drawing Setup.

**Export LandXML File**

The Export LandXML File routine provides a mechanism where data can be sent from Carlson Software into a LandXML file for use in other applications that support the LandXML data specification. To generate a LandXML file, a series of dialog boxes are presented:
Export to LandXML: This option allows you to individually select the desired Carlson Software data file(s) that should be included in the LandXML file.

Project Data Files: This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

Select LandXML File: Specify the name of a LandXML file you wish to create.

Include Files Referenced in Select Files: When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to LandXML File dialog box.

Export to LandXML File: Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the LandXML file.

Change Directory: This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

Report: Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the LandXML file.
**LandXML Units:** Specify the desired Units of Measure that reflect the outgoing data.

**Point Protection:** When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those being selected for the LandXML file. When disabled, point data you've selected for the LandXML file are automatically written to (or updated into) the existing LandXML file.

**Exported Element Protection:** When enabled, you are prompted if existing data (such as a centerline) in a LandXML file should be updated with data of the same name that you have selected for the LandXML file.

**Precision:** Set the desired level of precision for each of the various measurement categories.

**Profiles:**

There are two major different types of profiles in LandXML: ProfSurf and ProfAlign. ProfSurf is typically an existing surface that is usually created using existing surface data. The data for this type of profile it is stored in a series of station-elevation values as a representation of a PntList2D list. ProfAlign is for a design profile. The data for this type of profile is stored in LandXML elements starting from the simplest one: PVI element, CircCurve element, ParaCurve element, etc.

Carlson differentiates the two types mentioned above by using the profile type in the Carlson .pro file: Generic = ProfSurf, Road = ProfAlign.

**Note:**

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don't have to own or use the CAD or software product used by your data provider).
• Visit http://www.landxml.org for additional information on the uses and acceptance of the LandXML initiative.

**Pulldown Menu Location(s):** File > LandXML  
**Keyboard Command:** `landxml_export`  
**Prerequisite:** Carlson project data files to convert

## Import RoadXML File

The Import RoadXML File routine provides a mechanism where road-based data from other software applications (including Carlson Software) can be brought into a project and used for analysis and/or design purposes. The program supports centerline and profile data in Trimble style RoadXML format. To import a RoadXML file, a series of dialog boxes are presented:

**Select RoadXML File:** The standard File Selector dialog box prompts you to identify an existing RoadXML (*.RXL) file you wish to import. The following dialog box is then displayed:

![Import from Trimble RoadXML](image)

- **RoadXML Units:** Indicates the Units of Measure associated with the incoming RoadXML file (see the Unit Differences item below).
- **Destination File Method:** This option allows you to indicate how the incoming data file(s) are named as they are imported.
- **Change Directory:** This option allows you to adjust the folder location where the new data files will be written.
- **Import from RoadXML:** Enable or disable various entries that should be used to produce the data files found within the RoadXML file.
RoadXML Units: RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor. Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative. **Pulldown Menu Location(s):** File > LandXML/RoadXML

**Keyboard Command:** roadxml import

**Prerequisite:** A RoadXML file to import

### Export RoadXML File

The Export RoadXML File routine creates a RoadXML RXL file using Carlson format centerline and profile files. This RoadXML file can be used for data exchange with other applications that support the RoadXML data specification such as Trimble. To generate a RoadXML file, a series of dialog boxes are presented:

**Current Drawing Data Files:** This option selects the various data files associated with, and defined by the Drawing Explorer command.

**Project Data Files:** This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

**Selected Data Files:** This option allows you to individually select the desired Carlson Software data file(s) that should be included in the RoadXML file. This is followed by:

**Select RoadXML File:** Use the standard File Selector dialog box to specify a new or append to an existing RoadXML file. This is followed by:
**Include Files Referenced in Select Files:** When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to RoadXML File dialog box.

**Export to RoadXML File:** Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the RoadXML file.

**Change Directory:** This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

**Report:** Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the RoadXML file.

![RoadXML Export Dialog](image)

**RoadXML Units:** The Units of Measure are displayed for the RoadXML file about to be created.

**Exported Element Protection:** When enabled, you are prompted if existing data (such as a centerline) in a RoadXML file should be updated with data of the same name that you have selected for the RoadXML file.

**Precision:** Set the desired level of precision for each of the various measurement categories.

Pick the Export button to complete the creation of the RoadXML RXL file.

**RoadXML Units:** RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor.
Indicate the desired action of what should occur if the units of the RoadXML do not match those of the current drawing.

Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative.

**Pulldown Menu Location(s):** File > LandXML/RoadXML  
**Keyboard Command:** roadxml export  
**Prerequisite:** Carlson project data files to convert

## Export Google Earth File

The Export Google Earth File allows you to produce a KML (Keyhole Markup Language or alternatively a KMZ) file of Carlson points, lines, arcs and polylines for rendering in other mapping and GIS applications such as Google Earth. Throughout this discussion, **KML** will be used to also describe KMZ files unless explicitly noted.

![Export to KML/KMZ Window]

**Drape on Google Terrain (2D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Clamped to ground."

**Use Elevations from the Drawing (3D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Absolute."

**Include Selected Points:** When enabled, this option exports selected Carlson point information to the KML `<Placemark>` `<Point>`...`</Point>` `<Placemark>` tag structure.

**Include Layer Information:** When enabled, this option organizes exported information based on the layer of each entity, with each CAD layer becoming a KML `<Folder>`...`</Folder>` entry with the color of the group taking the general color of the CAD layer.

**Shade Closed Regions:** When enabled, all closed polyline regions (*e.g.* building pads, ponds, *etc.*) will be fill-shaded.

**Export to KMZ Format:** When enabled, the KML file is written to the more compact (zipped) KMZ version of the standard KML file format.

**Display Results in Google Earth:** When enabled, the results of the KML are passed to and automatically opened with Google Earth.

**Note:**

- When the **Use Elevations from the Drawing (3D)** option is selected, be aware that elevation values lower than the Google Earth terrain may be obstructed in the Google Earth display.
- Attribute information (*e.g.* Number, Elevation, Description) of selected Carlson points are also written to the KML and will display in the "balloon" when a point is picked in the Google Earth display or data hierarchy.
• When the *Shade Closed Regions* toggle is enabled, note that **all** closed polyline regions will become fill shaded and may lead to undesired results for items such as closed contours.
• When prompted for the name of the KML/KMZ file to write, the appropriate KML or KMZ file extension based on the *Export to KMZ Format* toggle will be added to the file if the file extension is not specified.
• Arcs and polylines with arcs are converted into chord segments that closely approximate the arc(s).
• Other entities not supported for direct export to a KML file (*e.g.* circles, 3DFaces, ellipses, splines, multilines, regions and solids), can be first turned into polylines with the Entities to Polylines command. Text entities can be converted to polylines through the use of the Text Explode To Polylines command.
• The graphical symbology of any/all items sent to the KML file can be manually modified via the Google Earth interface.

**Prompts**

**Select points, polylines, lines and arcs to write.**

*FILter/*<Select entities>*: Select the desired entities and press Enter when complete.*

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.

**Pulldown Menu Location:** File > LandXML/RoadXML/Google Earth
**Keyboard Command:** kmlwrite
**Prerequisite:** Points, lines or polylines in the drawing with an established projection zone through Drawing Setup.

**Export Drawing to AutoCAD 14**

This command will save an existing Carlson drawing to AutoCAD R14 format. This command is for Carlson in AutoCAD 2004 and Carlson working in AutoCAD 2005.

**Prompts**

![Source Drawing To Load - (dwg)](image-url)
Source Drawing To Load dialog  select a .DWG file
AutoCAD R14 Format Drawing To Save dialog  select name for a new .DWG file

Files saves to R14.

Pulldown Menu Location: File
Keyboard Command: dwg2r14
Prerequisite: An existing Carlson .DWG file, using Carlson in AutoCAD 2004 or Carlson in AutoCAD 2005

Microstation DGN

This command converts drawing files between .DWG and .DGN file formats. This command is only available when running on IntelliCAD. When running on AutoCAD, the AutoCAD Import and Export commands can be used to convert .DGN files.

When converting DGN files to DWG file format, there are several processing methods. In all cases, multiple files can be selected and processed at a time. The Convert Files method creates DWG files from the selected DGN files. The DWG files automatically have the same file name as the source DGN files except with the different file extension of .DWG. The Insert as Block Reference method inserts the selected DGN files into the current drawing as blocks. The Insert as Entities method imports the entities from the DGN files into the current drawing. The Attach as External Reference brings the selected DGN files into the current drawing as Xrefs. The Overlay option for Attach as External Reference is the same except that this method is not nested.

For converting DWG files to DGN format, the Convert Files method creates DGN files from the selected DWG files. The Convert Current exports the current drawing. In both cases, the DGN files are automatically named after the source DWG files except with the different file extension of .DGN.
Pulldown Menu Location: File  
Keyboard Command: dgnio  
Prerequisite: A DWG or DGN to convert

Write Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. Several different output formats are supported.

The Carlson format (.PLN) is a text file format that is used by some Carlson commands and by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number, etc". Then the points for the polyline are listed on separate lines in X,Y,Z format.

The DTM and Idan formats create linework files for the DTM and Idan programs.

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline.

The Moss format creates a INP file for the MX/MOSS Genio program.

The Peabody format is a company specific format for Peabody Energy.

The Topcon format creates a Topcon LN3 file.

The 12D format creates a file format compatible with the 12d modeling program.

Note:

- The former Google (KML) output option has been moved to the dedicated Export Google Earth File command.

Prompts

Polyline file format [<Carlson>/DTM/Idan/MicroStation/MOSS/Peabody/Topcon/12D]? Specify the desired output option by specifying the CAPITALIZED option or press Enter for the <default> option.

Polyline File to Write dialog: Create a new file or Append to Existing. If the Carlson option was selected, the following dialog then appears:
Use Polyline File for Grid File Utilities macro: When enabled, the option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.

Specify Exclusion/Warning Polylines: When enabled, this option applies to machine control for warning areas.

Specify WorkZone Polylines: When enabled, this option applies to machine control for working areas.

Reduce Polyline Vertices: When enabled, this option applies the Reduce Polyline Vertices to the polyline vertices before writing the file.

Offset Cutoff: Indicate the allowable offset distance (essentially the middle ordinate distance of a 3-point arc) that would allow the middle vertex between two other vertex locations to be removed.

Include Z coordinate in polyline file: When enabled, this option controls whether the elevation(s) (or "Z" value) of the selected polyline vertices are written to the polyline file.

Decimals: Indicate the desired amount of precision for the coordinate values that should be written to the file.

Select polylines, lines and arcs to write.

FILTER/<Select entities>: Pick the entities to process press Enter when complete.

Sample Polyline File:

POLYLINE,51,0,0.0,CONT|V-STRM-PIPE
5375168.9320,3932304.7050,0.0000
5375193.3310,3932211.6150,0.0000

POLYLINE,150,0,0.0,CONT|V-BRKL
5375026.8800,3932090.0480,962.8334
5375062.3960,3932105.7540,961.5399
5375075.5640,3932115.7940,961.1595
5375079.0150,3932128.0920,961.1532
5375081.6860,3932159.7840,961.6147
5375086.6920,3932195.6480,962.6206
etc.

Pulldown Menu Location: File > Polyline File

Keyboard Command: polywrite

Prerequisite: Polylines in the drawing

Draw Polyline File

This command draws polylines from the selected polyline file. This command supports the following formats: Carlson (.PLN), Agtek (.WRL), CAICE (.SRV), Digital Line Graph (.DLG, .OPT), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN), Peabody (.PLY), Topcon Pocket 3D (.TXT) and 12D (.12da). For formats that contain only geometry without layer names, the polylines are drawn in the current layer. For 12D, in addition to drawing polylines, the routine also draws any text, symbols and points.

Prompts
Polyline file format [Carlson>/Agtek/Caice/DLG/DTM/Idan/MicroStation/MOSS/Peabody/Topcon/12D]? press Enter for Carlson default

Polyline File to Read Dialog select existing .PLN file

Pulldown Menu Location: File->Polyline File

Keyboard Command: polydraw

Prerequisite: A polyline file

Translate Layers

This command renames layers using a lookup table with pairs of original and renamed layer names. This command can be used to convert the layers for a drawing from another source to match your layer standards. The layer names are entered in a spreadsheet. The Add, Insert, Delete and Sort buttons work on the spreadsheet rows. The Report button makes a report for the layer assignments. The SaveAs and Load functions store and recall the layer assignments to a .LTF file for sharing the settings or keeping different sets of layer assignments.

![Layer Translation Table Editor](image)

Pulldown Menu Location: File > Drawing Utilities

Keyboard Command: translayers

Prerequisite: None

Remove XData

This command removes the xdata (Extended Entity Data) from the selected entities. Many Carlson routines add xdata to entities in order to add extra program specific information to them. Carlson programs use the xdata to make entities more intelligent. For example, when you draw a centerline (.cl) as a polyline, xdata is attached to the polyline that stores the reference of the .cl file name. Then if you double-click the polyline, then the program can read the xdata to know the polyline is a centerline and launch the centerline editor. By removing the xdata, the entities revert to regular CAD entities which is useful if you want to detach these entities from the program links.

Prompts
Select entities to remove extended entity data from.
Select objects: pick the entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: xxdata
Prerequisite: Entities with xdata

Remove Reactors
This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that is General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts
Select entities to remove reactors from:
Select objects: pick the entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Prerequisite: Entities with reactors

Remove Groups
This command is used to "ungroup" selected entities that, prior to using this command, were part of a group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD or IntelliCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.

Prompts
Select entities to remove from groups.
Select objects: select entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroup
Prerequisite: Entities in group(s)

Record Script, End Script, Run Script
These commands process a sequence of commands. First, the Record Script command creates a script file (.scr). When the Record Script is active, the commands that you run and the input data is written to the script file. The End Script command stops the script recording. Then the Run Script command can be used to reprocess the commands and input from the script file. The script file is a text file that you can edit with any
text editor such as Notepad or the Display-Edit File command. You can edit input data files as well as the commands.

The script supports the following commands: Draw-Locate Points, Inverse, Traverse, Sideshot, Bearing-Bearing Intersection, Bearing-Distance Intersection, Distance-Distance Intersection.

These scripts can be useful for batch processing a repetitive input. Also, the script can be used as a backup of data input for reprocessing after editing input values.

In the script file, the user-input values are after the "=". Anything on a line that is after a ";' is a comment. The command prompts are included in the script file for easier reading. Here is a sample SCR file:

```
c:inverse ; Command: INVERSE
Traverse/SideShot/Options/Arc/Pick point or point number: =>26
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: =>24
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: =>SS
Exit/Help/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>: =>
Enter Angle (dd.mmss) <90.0000>: =>45.1515
Points/<Distance>: =>59.2
Enter Zenith Angle (dd.mmss) <90.0000>: =>90.1234
Enter Point Description <>: =>IP
Exit/Help/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>: =>e
```

**Pulldown Menu Location:** File > Scripts

**Keyboard Command:** recscr, endscr, runscr

**Prerequisite:** None

---

**Edit Menu**

In addition to powerful CAD engine editing commands, the Carlson Edit menu has the additional commands which are explained in this section. Commands that are pure AutoCAD or IntelliCAD are not detailed here. They can be found in the CAD manual.
Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline. The Save and Load buttons save and recall the layer names.
Pulldown Menu Location: Edit > Erase
Keyboard Command: ldel
Prerequisite: Something to erase

Erase by Closed Polyline

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog.

The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.

In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

Pulldown Menu Location: Edit > Erase
Keyboard Command: erasepline
Prerequisite: Entities and a closed polyline
Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

Prompts

Pick 1st corner of window to erase outside of: Pick point location
Pick 2nd corner: Pick second point location
Pulldown Menu Location: Edit > Erase
Keyboard Command: eraseout
Prerequisite: Entities to erase

Temporary Erase

This command erases the selected entities while keeping track of their data to allow restoring them. To unerase the entities, simply run the command again. The program keeps track of the erased data only during the current drawing session. If you exit the drawing, the entities cannot be restored when the drawing is opened again.

Prompts

Select entities for temporary erase.
Select objects: pick entities to erase

Pulldown Menu Location: Edit > Erase
Keyboard Command: terase
Prerequisite: Entities to erase

Copy To Layer

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).
Prompts

Select entities to copy.
Select objects: select entities
Select Layer dialog select a layer from list and click OK

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy2layer
Prerequisite: Entities to be copied

Copy Polyline Section
This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline
Select first break point along polyline: Pick location on the polyline
Select second break point along polyline: Pick the second location on the same polyline
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy.pl
Prerequisite: Polyline to be copied

Offset To Layer
This is a command to offset a polyline and put the offset polyline into a separate layer from the original polyline.

Prompts

Offset to layer <0>: ROW
Enter the offset amount: 20
Select object to offset: pick a polyline to offset
Specify point on side to offset: pick a point

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_layer
Prerequisite: Linework to offset

Offset to Area
This command offsets a polyline by a distance that results in creating the specified target area. The source polyline should represent the frontage on the area. There is an option to connect the sides between the source and offset polylines to make a closed polyline.
Prompts

Pick line or polyline to offset: pick a polyline
Select side to offset: pick a point on the offset side
Keep existing polyline [Yes/<No>]? press Enter
Create closed polyline [<Yes>/No]? press Enter
Acres/<Enter target area (s.f.)>: 90000

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_area
Prerequisite: polyline to offset

Multiple Offsets

This command applies the same offset multiple times in series from the original polyline.

Prompts

Specify offset distance <20.0000>: 25
Enter Number of Repetitions <1>: 3
Select object to offset or <exit>: pick a polyline to offset
Specify point on side to offset: pick a point
Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_mult
Prerequisite: Linework to offset

Variable Offset

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter
Select a polyline to offset (Enter for none): pick polyline
Select side to offset: pick a point on the side to offset to
As you go from segment to segment, you can enter in different offset values for each line segment.
Enter the segment horizontal offset <0.000>: 56
Enter the segment horizontal offset <56.000>: 33
Enter the segment horizontal offset <33.000>: 12
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: VOFFSET
**Block Explode**

This command retains the values of attributes when a block is exploded. The standard *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location:** Edit  
**Keyboard Command:** explode2  
**Prerequisite:** A block to be exploded

---

**Extend to Intersection**

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

**Prompts**

- **Select first line or polyline to extend:** *pick a line or polyline*  
- **Select second line or polyline to extend:** *pick another line or polyline*

---

![Before Extend to Intersection](image1)  
![After Extend to Intersection](image2)

**Pulldown Menu Location:** Edit > Extend  
**Keyboard Command:** extint  
**Prerequisite:** Two lines or polylines

---

**Extend Arc**

This command extends an arc entity.

**Prompts**

- **Pick arc to extend:** *select an arc entity*  
- **Break Arc at Extension [Yes/<No>]?:** *N* Answering Yes will create a new arc starting at the end of the existing...
Enter or pick the distance to extend: 5 This extends the arc 5 units
Enter or pick the distance to extend ('U' to Undo): press Enter to end

Pulldown Menu Location: Edit > Extend
Keyboard Command: extarc
Prerequisite: An arc

Extend by Distance

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.

The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

# - Number: Distance to draw or extend
A# - Angle change: Rotates pointer by specified number of degrees
A - Align: Rotates pointer to align with segment
B - Bearing: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
C - Close: Closes the polyline
D - Draw Mode: Actions draw or extend the line or polyline
E - Extend to Edge: Extends to intersection with a selected line or polyline
I - Input mode: Toggles distance input between decimal feet and feet-inches
L - Left rotate: Rotates counterclockwise 90 degrees
M - Move Mode: Actions only move the pointer
N - Next: Moves pointer forward to next point
O - Open: Opens the polyline
P - Previous: Moves pointer backward to previous point
R - Right rotate: Rotates clockwise 90 degrees
S - Switch: Reverses pointer direction
T# - Total distance: Sets current segment to specified distance
U - Undo: Undo the last Extend by Distance command
Z - Zoom mode: Toggles auto-zoom between on/off
? - Info: Displays lengths of current polyline

H - Help: The Help option also displays this Extend by Distance Commands list.
Press <Enter>: Ends the routine

![Image of Extend By Distance Info dialog box]

The result of using the Info (?) feature

Prompts

Select line or polyline to extend: select line or polyline near the place to extend
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):  50 The line is extended by 50 units.
Use the Pick option to pick a distance.
Pick/Horizontal Distance to Extend ([Enter] for new line):  R Rotate right 90 degrees.
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):  50 The line is extended by 50 units.
Use the Pick option to pick a distance.
Extend another (<Yes>/No)?  No
Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

**Pulldown Menu Location:** Edit > Extend  
**Keyboard Command:** extender  
**Prerequisite:** An existing line or polyline with at least one segment from which to start.

---

**Break by Crossing Polyline**

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

---

**Prompts**

Select the clip edge polyline: *pick a closed polyline*  
Select the polylines and lines to be clipped.  
Select Objects: *pick the entities to break*  
Specify layer names for Inside segments (Yes/No)? *Yes*  
Enter a layer name for the Inside segments <0>: *press Enter*  
Specify layer names for Outside segments (Yes/No)? *Yes*  
Enter a layer name for the Outside segments <0>: *Final*
Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline
Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.

Break at Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the Area by Lines & Arcs command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

Prompts

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point
**Change Elevations**

This command will change the elevation of selected entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.

**Prompts**

- **Ignore zero elevations** (<Yes>/No)? *press Enter* If you answer No, then entities with elevation 0 will be changed.
- **[A]bsolute or [D]ifferential Change** <A>: A
- **Elevation to change to**: 125 By using the Absolute option all entities selected are changed to the elevation 125.
- **Select Entities for elevation change**.
- **Select objects**: C
  - **First corner**: pick a point
  - **Other corner**: pick a point
  - **Select objects**: press Enter

If Carlson points are selected, the command warns:
- **This command DOES NOT change the elevations in the Coordinate file!**
- **Use Coordinate File Utilities menu option F to update the file.**

**Change Attribute Style**

This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under **Existing Style**, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the **Pick Attr** button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Select the **New Style** that you want to apply to the attributes.

Enter a **New Height** for the attributes. An entry of zero (0) will not modify the existing height.
Pulldown Menu Location: Edit > Change

Keyboard Command: chgattr

Prerequisite: You may want to use the LIST command to check the current Text size.

Change Style

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under Existing Style, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the Pick TEXT button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the New Style that you want to apply to the text.

Enter a New Height for the text. An entry of zero (0) will not modify the existing height.
Change Colors

This command is designed to change the original color of existing entities in the drawing to a different color. This is done using the Change Colors dialog. You must match up the original colors of original entities to the preferred colors that they will change to. These "destination colors" are directly to the right of the original colors in the dialog (on the same row). You then click OK and select the specific entities on-screen that you want changed. This routine changes all entities in the drawing that you have chosen and that have an original color that has been changed. Do your dialog box color selections and matching up first, followed by OK. Then select the entities.

![Change Colors dialog]

Prompts

**Change Colors dialog** Create your color change schemes and click OK.

**Select entities to change colors.**

**Select objects:** select entities

**Pulldown Menu Location:** Edit > Change

**Keyboard Command:** chgcolor

**Prerequisite:** Entities whose colors are to be changed

---

Change Block/Inserts Rotate

This is a command to set the angle of blocks by various methods. This command optionally can change the rotation of a block by twist screen angle, azimuth, entity segment or by follow polyline. It will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm, insert it in, and then want to change the rotation.

Prompts

**Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]?** press Enter

Enter angle relative to current twist screen <0.0>: 30

**Select Symbols to Rotate.** pick symbol

**Select objects:** 1 found

**Pulldown Menu Location:** Edit > Change > Block/Inserts

**Keyboard Command:** TWISTSYM
Change Block/Inserts Substitute

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

Existing Block: Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.
Replace With: Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select a drawing file.
Retain Size and Rotation: When checked, the new block will retain the size and rotation values from the old block.
New Size: Available if Retain Size and Rotation is not checked. Enter the size for the new block.
New Rotation Angle: Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: chgblk
Prerequisite: None

Change Block/Inserts Resize

This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts
Scaling Multiplier <0.5>: Enter the size scale factor.
Select symbols and blocks to scale.
Select objects: select entities

Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: sizeblk
Prerequisite: block/inserts in drawing

**Pivot Point Rotate by Bearing**

This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

**Prompts**

Select entities to rotate.
Select objects: select the entities
Base pivot point ?
Pick point or point number: 2 The program then reads the coordinate value for pt#2 from the current CRD file.
Reference Bearing point ?
Pick point or point number: pick a point
Reference Bearing N 44d31'1'' E The program then displays the reference bearing defined by the two points selected.
**Azimuth/ Bearing (Qdd.mmss)> 245.3030** Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.

If Carlson Points are selected the program warns:
This command DOES NOT change the coordinates in the Coordinate file!
Use Coordinate File Utilities menu, Update CRD from Drawing.
This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.

Pulldown Menu Location: Edit > Rotate
Keyboard Command: brot
Prerequisite: None

**Entity Insertion Point Rotate**

This command allows you to rotate the selected entities where the rotation pivot point for each entity is the insertion point of the entity. The rotation angle will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick. This routine processes TEXT, MTEXT and INSERT entities only.

**Prompts**

Rotate by [Twist screen]/Azimuth/Entity segment/Follow/Pick]? F
Select polyline to follow: pick a polyline
Select Entities to Rotate.
Select objects: pick entities to rotate
Flip text for twist screen [Yes/<No>]? Y

Rotating ....

Pulldown Menu Location: Edit > Rotate
Keyboard Command: ss_twist
Prerequisite: Entities to rotate

Text Enlarge/Reduce
This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl

Move Text
This command moves existing text entities by sliding at the text angle or perpendicular. This sliding method is equivalent to setting the crosshairs to the text angle and then moving with ORTHO on.

Prompts

Select Text to slide:
Select objects: pick text entities
Pick starting point for slide: pick a point to begin sliding and then pick a second point for the new location

Pulldown Menu Location: Edit > Text
Keyboard Command: annslide
Prerequisite: Text entity to move

Move Text with Leader
This command moves an existing text entity and creates a leader from a picked point to the new text location. The routine keeps track of the original text location and has an option to restore the text to the original without the leader. To use the Restore function, type R at the Command prompt. Also, to access the options for this command, type O for Options at the Command prompt.

Prompts

Select Label to Move (O for Options, R for Restore): pick any text entity
Pick start point for leader: pick the point where to draw the leader arrowhead
Pick end point for move: pick the end of the leader where to move the text
Select Label to Move (O for Options, R for Restore): O

When Options is chosen the "Move Text With Leader Options" dialog allows the user to customize the leader and label drawing settings:
Minimum Leader Length Scaler: If the distance of the move is less than this value, a leader will not be drawn.
Draw Horizontal Leader Tick: When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.
Leader Offset Scaler: This is used to set the distance from the end of the leader and the annotation.
Use Separate Leader Layer: This allows the user to place the leader on a separate layer from the annotation.
Keep Label Alignment: This option keeps the original text angle. Otherwise the leadered text is orientated horizontally to the current twist screen.
NOTE: The leader scaler units (Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value which is set under Drawings Setup.
Select Label to Move (O for Options, R for Restore): R
Select Label to Restore: pick a text that had been moved with the "Move with Leader" command previously. The selected label will be restored to its previous state.

Pulldown Menu Location: Edit > Text
Keyboard Command: movetext
Prerequisite: Text entity to move.

Rotate Text
This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

Prompts
Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

Pulldown Menu Location: Edit > Text
Keyboard Command: twisttxt
Prerequisite: Text

2D Scale
This command will scale selected entities using a specified scale factor and base point. This 2D Scale method differs from the 3D Scale method in that it only scales the entities in the x,y coordinates and does not change the elevations of the entities. A case for using 2D Scale is when the x,y coordinates are in architectural units of
inches and the elevation is in feet and you want to convert the x,y coordinates to feet. When the entities are at zero elevation, then 2D Scale makes no difference and it is better to use 3D Scale because it is faster.

In the dialog shown here, you have the ability to determine what is scaled: the entire drawing or a selection set. If you choose Select Objects, you will be prompted to select the entities to scale after clicking the OK button.

```
function hideInfo() { info = document.getElementById('infoline'); info.innerHTML = ''; info.style.visibility = 'hidden'; }
function showInfo(title) { info = document.getElementById('infoline'); info.innerHTML = title; info.style.visibility = 'visible'; }
```

The Base Point acts as the center of the scaling operation and remains stationary. The base point you specify identifies the point that remains in the same location as the selected objects change size.

There are two methods for scaling entities: by Units Conversion or by a Customized Scale Factor. The dialog above shows one application of this routine, converting a drawing from architectural (Inches) to decimal units (US Feet) when the architectural units have the drawing x,y coordinates in inches and the elevations in feet. In this case, 2D Scale can be used to apply a 1/12 scale factor (0.08333333) to convert the inches to feet for the x,y coordinates and leave the elevations unchanged.

If the scale you want to apply is not a standard conversion, a manual scale can be entered by checking on the Use Customized Scale Factor checkbox. A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1 shrinks the object.
To scale a drawing by a known distance on the plan (which is often the case when working with PDF imports) select the Screen Pick button. This will prompt you to pick the beginning and ending points along a known distance (Like the bar scale above). The program will then report the current distance of the segment (in this example 608.369) and allow you to enter in the desired distance (which is 40 in this case).

![Enter distance (608.369)](image)

The program will then calculate the proper Scale Factor to apply to the selection set. In this example, .0657769021 on the Entire Drawing.

**Pulldown Menu Location:** Edit > Scale  
**Keyboard Command:** scscale  
**Prerequisite:** None

### Change Text Font

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.
Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtstyle
Prerequisite: Text entities to be changed

Change Text Size
This command will change the size of the selected text objects to the user specified size. The Text Enlarge/Reduce command also changes text size. The difference is that this routine sets the text to an absolute size whereas Text Enlarge/Reduce scales, or relatively changes, the text size.

Prompts
Select the text to size.
Select objects: select the text
Enter new text size: enter value

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtsize
Prerequisite: Text entities to be changed

Change Text Width
This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.

Iron Pin  
Iron Pin  
Iron Pin  

Text width = 1
Text width = 0.75
Text width = 1.5

Effect of different width factors on the same text line
Prompts

Select the text to change.
**Select objects:** *select text entities*

**Enter new width factor** <1.0>: *enter new width factor*

**Pulldown Menu Location:** Edit > Text

**Keyboard Command:** chgtxtwidth

**Prerequisite:** Text entities to be changed

---

**Change Text Oblique Angle**

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

**Prompts**

Select the text to change.
**Select objects:** *Select text to change oblique angle on*. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.

**Enter new oblique angle** <0.0>: Enter the desired oblique angle.

![Iron Pin](oblique_angle.png)

Oblique Angle = 0

Oblique Angle = -20

Oblique Angle = 25

**Pulldown Menu Location:** Edit > Text

**Prerequisite:** Text entities to be changed

**Keyboard Command:** chgtxtoblique

---

**Flip Text**

This command will change the alignment of text entities by 180 degrees.

**Pulldown Menu Location:** Edit > Text

**Keyboard Command:** fliptext

**Prerequisite:** Text entities to be changed
Flip Text By Twist Screen

This command will change the alignment of text entities by 180 degrees for any selected text that are upside-down relative to the current drawing twist screen (dview twist).

Prompts

Select Text to Flip for Twist Screen.
Select objects: pick the entities

Pulldown Menu Location: Edit > Text
Keyboard Command: annflip
Prerequisite: Text entities to be changed

Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

Pulldown Menu Location: Edit > Text
Keyboard Command: txtbrk
Prerequisite: Text entity to break

Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the Write Polyline File command.

Prompts

Select text to be EXPLODED.
Select objects: select the text
Substitute With Simple Font [<Yes>/No]? Y
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Reading the selection set ...
Joining ...
Converting ...
Add Prefix/Suffix To Text
This command simply adds a prefix and/or suffix to the selected text entities. The strings to add are specified in a dialog. Then you select the text entities to update.

Prompts
Add Prefix/Suffix To Text dialog
Select text to process.
Select objects: pick the text entities
Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: textexp

Remove Spaces From Text
This command removes leading and/or trailing spaces from the selected text entities.

Prompts
Trim all spaces from text on [Right/Left/<Both>]: press Enter
Select text to process.
Select objects: pick the text entities to process
Trimmed spaces from 1 text entities.

Pulldown Menu Location: Edit > Text
Keyboard Command: txtrmspace
Prerequisite: Text entities

Line Up Text
This command lines up the selected text entities along either a horizontal or vertical line position.

Before and after Line Up Text

Chapter 2. General Commands 113
Prompts

Line up text on [Horizontal/<Vertical>]: press Enter for Vertical
Pick vertical position: pick a point
Select text to process.
Select objects: select the text to process

Pulldown Menu Location: Edit > Text
Keyboard Command: txtlineup
Prerequisite: Text

Join Text Entities
This command combines two text entities by appending the second text to the first. The Words join method puts a space between each text. The Letter join method appends without a space.

Prompts

Select first text line: pick a text entity
Select text to add to first text line: pick a text entity
Join type as [Words/<Letters>]: press Enter

Pulldown Menu Location: Edit > Text
Keyboard Command: txtjoin
Prerequisite: Text entities

Replace Text
This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. In AutoCAD 2000 and later, the command Find and Replace Text includes more options, including replacing partial strings and searching attributes and MTEXT.

Pulldown Menu Location: Edit > Text
Keyboard Command: chgttext
Prerequisite: Text entities to be changed

Select by Elevation
This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [<Greater>/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [<Yes>/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...

Chapter 2. General Commands 114
Built selection of 120 objects for elev more than 19.00.
To use type 'P' at Select objects: prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: zselect
Prerequisite: Entities

2D Align
This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the standard Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.

Before and after 2D Align

Prompts
Select entities to align.
Select objects: pick entities to process
First Source Point?
Pick point or point number: pick point 84
First Destination Point?
Pick point or point number: pick point 18
Second Source Point?
Pick point or point number: pick point 85
Second Destination Point?
Pick point or point number: pick point 19
Scale factor: 1.00434258
Scale objects based on alignment points [Yes/No]? Y
This command DOES NOT change the coordinates in the CooRDinate file!
Use Coordinate File Utilities menu, Update CRD File from Drawing.

Pull down Menu Location: Edit > Align
Keyboard Command: scalign
Prerequisite: None

Entities to Polylines
This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use Join Nearest to convert adjoining lines and arcs into continuous polylines.

Prompts
Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: select entities
Pull down Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert

Reverse Polyline
This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands Station Polyline, MXS by Polyline, Profile from Surface Model or CL File from Polyline, since the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the Reverse Polyline command to change its order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

Prompts
Select the Polyline to Reverse: pick a point on polyline
Pull down Menu Location: Edit > Polyline Utilities
Keyboard Command: revpline
Prerequisite: A polyline

Reduce Polyline Vertices
This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a
polyline with three points in a straight line, the middle point can be removed without changing the polyline. This command is explained further in the Triangulate & Contour command.

Prompts

Enter the offset cutoff <0.1>: .5
Select polylines to reduce.
Select objects: pick polylines
Processed polylines: 1
Total number of vertices: 10
Number of vertices removed: 1

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: reduce
Prerequisite: A polyline

Densify Polyline Vertices

This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.

Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity > 1
Added 17 points to 1 polyline.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips are temporary. Any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.

Chapter 2. General Commands
Prompts

Select polylines to draw blips.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline

Draw Polyline Start/End

This command simply draws symbols at the start and end vertices of a polyline to give a visual indication of the polyline direction. The routine starts with a dialog to select the different symbols for the start and end, and to select the layer and size for the symbols. Then you select the polylines and the program draws the symbols.
Prompts

Polyline Start/End Settings dialog
Select polylines.
Select objects: select polyline(s)
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plends
Prerequisite: A polyline

Set Polyline Origin
This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

Prompts

Select Polyline: pick a polyline
Pick Near New Origin Point: pick a point on the polyline to be the starting point
Processing ...
Select Polyline: press Enter
Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: plchgorg
Prerequisite: A closed polyline

Add Intersection Points
This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Chapter 2. General Commands
The options dialog allows you to set the layer for the new polylines. Otherwise the original polyline layer is used. There is an option whether to keep or erase the original polylines. The Snap Tolerance is the maximum offset allowed between the original points and the arc.

![Add Arcs to Polylines dialog](image)

**Prompts**

Add Arcs to Polylines dialog
Select polylines to process.
Select entities: *pick the polylines*

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addplarc
Prerequisite: polyline

**Edit Polyline Vertex**

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.
Prompts

Select polyline to edit: pick a polyline
Pick point on polyline to edit: pick a point to be modified
Edit Polyline Vertex dialog click "Pick Position"
Pick vertex position: pick a new location for the vertex
Edit Polyline Vertex dialog click OK

Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

Select polyline to edit (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Prerequisite: A polyline

Edit Polyline Section

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select polyline to edit: pick the polyline at the place to start editing
Pick intermediate point (Enter to End): pick a point
Pick intermediate point (‘U’ to Undo, Enter to End): pick a point
Pick intermediate point (‘U’ to Undo, Enter to End): press Enter
Pick reconnection point on polyline: pick the polyline at the place to join
Remove Duplicate Polylines

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

Prompts

Select lines, arcs and polylines to process.
Select objects: select linework to process
Reading the selection set ...
Removed 1 duplicate linework entities.

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts
Select polylines to remove arcs from.
Select objects: *pick polylines
Offset cutoff <0.5>: *press Enter

**Pulldown Menu Location:** Edit > Polyline Utilities > Remove Polyline
**Keyboard Command:** rmarc
**Prerequisite:** polyline with arcs

---

## Remove Polyline Segment

This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.

![Diagram of Polyline Segment Removal Options]

---

### Prompts

*Break polyline at removal or keep continuous (Break/<Continuous>)?* press Enter

Select polyline segment to remove: *pick point on polyline
Select polyline segment to remove: *press Enter to end

**Pulldown Menu Location:** Edit > Polyline Utilities > Remove Polyline
**Keyboard Command:** removepl
**Prerequisite:** A polyline

---

## Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.
Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline

Create Polyline ID Labels

This command labels the selected polylines with either the entity "Handle", which can be seen with a list, or with unique text numbers, such as 1, 2, 3, 4, etc.. When using the Text option, the following window appears to choose the text settings.

![Sequential Numbering Options Window]

Prompts

Select Polylines to label.
Select objects: pick polyline
Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. The looping factor controls smoothing amount. A higher factor gives more looping. This command is explained further in the Surface menu section.

Prompts

Enter the looping factor (1-10) <5>: 7
Enter the offset cutoff <0.05>: press Enter This is the same reducing filter described above.
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Change Polyline Width

This command sets the width of the selected polylines. In later versions of AutoCAD, the command PEDIT can also modify the width of multiple polylines.

Prompts

New width <1.0>: 2
Select Polylines/Contours to change width of: 
Select objects: pick polylines

Check Elevation Range

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.
Prompts

Enter elevation range minimum: 0
Enter elevation range maximum: 4900
Select polylines to check.
Select objects: pick polylines to process
Found 1 polylines outside of elevation range.
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: checkpl
Prerequisite: Polylines with elevations

Highlight Non-Perpendicular Intersections

This command highlights selected polylines that have T-intersections with other polylines that are non-perpendicular. For example, this command can be used to check that side lines for lots are perpendicular to the frontage polyline. For every non-perpendicular intersection, a temporary graphic arrow is drawn and the angle and the coordinates of the point are reported at the command line.

Prompts

Select the polylines to check.
Select objects: pick polylines to check
Warning: Polyline non-perpendicular by 0°00'47" at 5477.08,5047.53

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nonperp
Prerequisite: Polylines

Highlight Non-Tangent Polylines

This command highlights selected polylines that have non-tangent lineworks. For every non-tangent polyline, an arrow is pointed to the first non-tangent point, and the non-tangent angle and the coordinates of the point are reported at the command line.
Prompts

Select polylines to check.
Select objects: 1 found
Select objects: 1 found, 1 total
Select objects: press Enter to end
Polyline non-tangent by 32°15'26'' at 1540.41,-182.05
Highlighted 1 non-tangent polylines.

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nontangent
Prerequisite: Polylines

Highlight Crossing Plines

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.
Prompts

Select polylines to check.

Select objects: pick polylines to process

Ignore zero elevations [<Yes>/No]? press Enter for Yes to filter out polylines at zero elevation

Reading points ... 1677

Finding points on breaklines ...

19 crossing polylines are highlighted.

Use Report Formatter [Yes/<No>]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.

Minimum delta Z to report <0.0>: 2

Add polyline vertices at intersections [Yes/<No>]? Y

Set 3D polyline to crossing contour elev or average elevs [Set/<Average>]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of...
the intersection point as the average of the crossing polyline elevations at that point.

Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: xing, plines
Prerequisite: Polylines with elevations

Highlight Unclosed Polylines

This tool will evaluate polylines you select and highlight those that are open. It also provides options to close all or selected polylines from those found.

First select all polylines to evaluate. The tool will then display those that are open in a highlighted appearance. You will be offered an option to close all or selected polylines. If you wish to close all the open polylines, choose the All option. If you choose the Selected option you will be prompted to pick which polylines you want to close. As you pick each polyline it will be closed.

Prompts

Select the polylines to check.
Select objects: pick polylines to process
Open polylines are highlighted.
Close all or selected polylines [All/<Selected>]? S
Pick polyline to close: press Enter to end or select polylines

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: unclosed
Prerequisite: A polyline

Close/Open Polylines

These commands allow you close or open multiple polylines respectively. In AutoCAD 2000 and higher, you can also use the PEDIT command.

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: closepl, openpl
Prerequisite: A polyline

Buffer Offset

This command offsets a polyline, and maintains a fixed distance from the original polyline by placing an arc on convex corners. The standard Offset command can actually have a distance greater than the offset at corners. In the example shown, the distance between the corners of the original and offset polylines is 70.01, while the offset distance is 50.0. Buffer Offset makes an offset polyline that doesn't exceed the offset distance. This is useful when you want an offset that goes no further than the offset distance, such as wetland offsets. Later versions of AutoCAD can achieve the same effect using the standard Offset command by changing the system variable OFFSETGAPTYPE to 1.

Prompts

Enter the offset amount: 50
Select object to offset: pick the original polyline

Chapter 2. General Commands
Specify point on side to offset: pick a point on the side to offset to

Regular Offset

Buffer Offset

Pulldown Menu Location: Edit > Offset
Keyboard Command: boffset
Prerequisite: A polyline to offset

Fillet 3D Polyline
This command fillets two segments of a 3D polyline with the given radius. The standard \textit{FILLET} command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

Prompts

Fillet corner of a polyline or intersection of two polylines [\textit{Corner}]/\textit{Intersection}]? press Enter
Enter fillet radius \textit{<10.00>}: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: fillet3d
Prerequisite: 3D polyline

Join 3D Polyline
This command joins \textit{3DPOLY} entities into a single 3D polyline entity.

Prompts

Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first
3 segments added to the polyline.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: join3d
Prerequisite: Plot the \textit{3DPoly} lines to use for selection

Offset 3D Polyline
This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are five offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the
polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

The surface method allows to offset/project a 3D polyline entity on to a surface (tin;flt;grd) based on cut and fill outslope ratio.

The multiple method allows multiple offsets of a 3D polyline with separate layers. User can add, insert and delete offsets rows and set individual layers. The option Progressive Offsets draws offsets progressively, i.e. successive offsets uses last drawn offset as base.

Prompts

Enter the offset method [<Interval>/Constant/Variable/Surface/Multiple]: press Enter
Vertical/<Horizontal offset amount>: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: offset3d
Prerequisite: Plot the 3D Poly lines to use for selection.
Add Point by Two Slopes

This command inserts a vertex into a 3D Polyline between two points based on the slopes specified for these two points on polyline.

Prompts

Select polyline to process: select a polyline
Select first point on polyline: select a point on polyline
Enter percent slope from first point: -1.0
Select second point on polyline: select a second point on polyline
Enter percent slope from second point: -1.0

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: plzslopes
Prerequisite: 3D Polylines

Join Nearest

This command joins lines, arcs and/or polylines together. While the PEDIT-Join command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.

Max Separation to Join: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.
Max Deflection Angle (degrees): This option will not join any lines if the angle between them is greater than this angle in degrees.
Connection Method: Determines how to connect the endpoints. See the illustration below.

1. Average Endpoints Together: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. Directly Connect Endpoints: Original endpoints are connected with new segment (see the middle illustration below).
3. **Fillet with Radius Zero**: Same as the *FILLET* command using zero radius (see the illustration on right).

**Convert Lines and Arcs Into Polylines**: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

**Join Across Intersections**: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

**Join Only Identical Widths**: When checked, only polylines with the same width will be joined.

**Join Only Identical Layers**: When checked, only entities on the same layer will be joined.

**Join Only Common Elevations**: When checked, only endpoints located on the same elevation will be joined.

**Different Layer Prompt**: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

**Different Elevation Prompt**: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

**Pulldown Menu Location**: Edit

**Keyboard Command**: nearjoin

**Prerequisite**: Lines or polylines to be joined

---

**Solid Fill Polyline**

This command fills the interior of closed polylines with 3D Faces to make the polyline areas appear solid. Closed polylines for exclusion areas can be used to exclude areas from the fill. Text can also be selected to exclude the text area from the fill. As an alternative, you can use the *HATCH* command, which creates an associative link between the hatch object and its boundary, interior boundary and any text that is excluded.

---

**Prompts**

**Solid Fill Dialog Box**

*Use Layer/Color of Perimeter Polyline* This option uses the layer and color of the perimeter polyline for the solid
Pick Interior Point to Make Perimeter Instead of requiring a closed perimeter polyline, this option defines the perimeter by the boundary of the area around a picked point.

Make Block of Solid The solid is created by adjoining 3D faces. This option groups the 3D faces into a block.

Select Inclusion perimeter polylines.
Select objects: pick closed polyline
Select Exclusion perimeter polylines.
Select objects: press Enter
Select Text to Exclude from fill.
Select objects: press Enter

Pulldown Menu Location: Edit
Keyboard Command: solidfill
Prerequisite: A closed polyline

3D Entity to 2D
This command changes a 3D Line, Arc, Circle, Polyline, Insert or Point to 2D, i.e. an entity with the elevations of the endpoints at the same Z coordinate. When the program detects a 3D polyline with all vertices with the same elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation here is used.

Prompts

Select/<Enter Elevation <0.00>: press Enter
Select Lines, Arcs, Circles, Polylines, Inserts and Points for elevation change.
Select objects: pick a 3D polyline
3D POLY to 2D POLYLINE
Number of entities changed > 1

Pulldown Menu Location: Edit
Keyboard Command: 3dto2d
Prerequisite: None

Add Points At Elevation
This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts

Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Select by Length

This command builds a selection set of linework objects in the drawing based on linework length. The length filter can be setup to get linework greater than or less than the specified value, or between two length values. After specifying the length criteria, the program prompts for selecting the linework to check. The program then builds a selection set of those objects that pass the length filter. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Prompts

Select by greater, less or between lengths [<Greater>/Less/Between]? press Enter
Enter length for greater than: 1000
Select objects to build selection set.
Select objects: pick linework to filter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: lenselect
Prerequisite: None

Select by Block

This command builds a selection set of blocks by using a block name filter. The block name to match is specified in a dialog with a list of all the block names in the drawing. Either pick from the list or use the Select From Screen button to get the block name by picking a block in the drawing. After selecting the block name, pick OK and the program will report how many of those blocks were found in the drawing and put into the selection set. This selection set is then ready to use at the next command with a select objects prompt. To use the selection set, type 'P' at the select objects prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: selblk
Prerequisite: Blocks
Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssgetarea
Prerequisite: Closed perimeter polylines

Select by Filter

This command can be used to build a selection set of objects inside a drawing based on layer and entity type. There is a dialog to define the filters. Select the layer(s) on the left you wish to select, then turn on the toggle(s) for the entity types to consider. There is an option to filter by entity color. Also, the size and style filters can be used for text entities. The program then builds a selection set of those objects that resides on those layers. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.
Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: fsel
Prerequisite: None

Select Similar
This command creates a selection set of all entities in the drawing with properties that match the selected entity. The properties filter uses the entity type and layer name. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: selectsim
Prerequisite: None

View Menu
In addition to powerful CAD display and view commands, the Carlson View menu has some additional commands. The commands in the top section effect the screen display size and location, and the bottom section commands change layers.
3D Viewer Window

This command views in 3D, the selected 3D faces, blocks, polylines, lines and points. This routine uses the OpenGL graphics library for rendering, which gives it superior performance. Some of its features include the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade in user-positioned lighting. Press the right mouse button and drag to zoom the display.
• **Ignore Zero Elevations:** When checked, the 3D viewer ignore entities at zero elevation.

• **Color By Elevation:** This will color the contours or 3D faces by elevation. The elevation scale legend is displayed on the left of the window.

• **Apply Texture:** Uses a texture pattern for shading surfaces.

• **Display Sky:** Creates a sky dome of 3D faces around the site that is colored blue with some clouds. In order to see the sky, your view point must be below the sky dome. This feature is only available when the software-only graphics mode is turned off under Carlson Configure->General Settings.

• **Vert. scale:** Sets the vertical scale factor for the 3D viewer. Relatively flat surfaces can be exaggerated by increasing the vertical scale.

This control represents position of the sun in the sky if looked from above. Therefore, the position of the sun in the center means that the sun is in a zenith, and position near the edge of the circle means that the sun is near the horizon. To move the sun, simply drag it to a new location, or click on the new location. The slide bars on the sides are the intensity and brightness of the display.

- **Zooms IN.**
- **Zooms OUT.**
- **Switch to Dynamic Zoom mode.**
- **Zoom Previous.**

Switch to Pan mode. Click and drag to pan.

Switch to Rotation mode.

Switch to initial view.

Toggles shading on and off.

This is an inquire tool. Point the arrow to any entity to display entity data including the layer, type, elevation and length.

Resets the 3D view to plan.

This function outputs the image to a report. The report format (PDF or DWF) is specified Settings->Configure->General Settings.

This function exports the graphic display to an image file. Several different image file formats are supported including bmp, png, jpg, xpm and gif. There is a Export Image Selections dialog to choose the image resolution and color depth.

- **Exit the 3D viewer window.**

• **Clip Plane:** This slider will clip the image based on the location of the slider. When the slider is all the way to the left, the entire image is displayed. Moving the slider to the right will clip the image, going deeper as the slider is moved to the right. This is useful to view items that are hidden behind something else.

• **Scroll Bars:** Use X,Y,Z scrollbars near the bottom to rotate the view. The range of these scrollbars is -180 to +180 degrees with middle being 0 which is the default position when the viewer starts. When the cursor is near the middle of the window, the XY icon will allow for rotating the image with the mouse, while holding the left mouse button. Move the cursor to the edge, and the icon switches to Z. This allows for rotating around the Z axis with the mouse, while holding the left mouse button. The Lock toggles hold the axis rotation fixed both for the scroll bar and when dragging with the mouse in the viewer.
• **Fixed Views:** This selection list sets a pre-defined view. Plan View sets the view to look straight down. The other views look from a low angle from the NE, SE, SW or NW.

![View Control Settings Advanced]

- **Display Axis Icon:** This controls whether to show the X/Y/Z axis icon in the lower left of the graphic window.
- **Display Bounding Box:** This controls whether to display a 3D box around the limits of the data.
- **Display Orbit:** Shows a graphic guide in the viewer for controlling the view angle and position using the mouse movements similar to the AutoCAD Orbit routine.
- **Apply Surface Smoothing:** This option controls the shading of 3D faces either flat by the normals of each 3D faces or smoothed by transitioning with neighboring 3D faces.
- **Display Triangle Edges:** Shows the edge lines for triangles for visualizing the triangles that make up a surface. When active, there is a setting to control the color for these edges.
- **Display Surface Names:** Shows the file names in the viewer for the surfaces currently being viewed.
- **Display Vertical Scale:** This controls whether to display the current vertical scale in the graphic window.
- **Display Non-Surface Entities:** This controls whether to display entities that have been tagged as "non-surface" by the Tag Non-Surface Entities or Points commands.

![Sets the drawing view to match the view shown in the 3D viewer window.]

This button sets the view position and target position by coordinates. The positions can be entered in the edit boxes or use the Pick button to pick a point in the drawing. The program will pick up the height of the surface for picked points and then the height above the position can be entered. For example to check sight distance, the view position could be a point on a road and height could be the driver eye height and the target position and height could be the object to check.
• **Color By Elevation Scale**: These three colors are used for the Color By Elevation option. The program will interpolate between these colors for the color scale.

• **Saved Views**: This option allows for naming and saving a 3D view. These can be selected from the pulldown. They can be deleted from the list.

---

**Advanced Tab**

• **Block Model Objects**: This option has three choices when loading block model entities. 1. To leave as points. 2. To Render and 3. To prompt each time. If render is selected, it will apply to all face objects such as a TIN or GRD.

• **Block Model layers**: This will display the block color scheme. Colors of the blocks can be turned on or off to view blocks in the middle.

• **Shading Mode**: There are 3 shading modes to render 3D faces. They are 1. Shade Front, 2. Shade Both, and 3. Shade Back. This will render the top and bottom of the faces if desired.
• **Surface Files Being Displayed**: This list controls showing multiple surfaces in the viewer. The Add Surfaces function allows adding grid or triangulation surfaces to the viewer. Double-clicking on a surface name in the list toggles on/off whether that surface is displayed. The Edit Surface Color button changes the color of a surface.

• **Use Dynamic Text**: This controls whether text objects resize based on the current zoom level or stay the fixed size according to their text size in the drawing.

**Pulldown Menu Location**: View  
**Keyboard Command**: cube  
**Prerequisite**: Entities to display

### Change Layer

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed it or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

![Select Layer Dialog](image)

**Prompts**

Select entities to be changed.  
**Select objects**: pick entities  
**The Select Layer dialog appears** select a layer from the list, or select Screen Pick  
If Screen Pick is chosen,  
**Pick entity with layer to change to**: pick another entity This assigns the selected entities to the layer of this entity.  
or  
**Enter new layer name or pick entity with layer (Enter/<<Pick>>)? E**  
**Enter new layer name**: FINAL This assigns the selected entities to the FINAL layer.

**Pulldown Menu Location**: View  
**Keyboard Command**: lchg  
**Prerequisite**: None

### Freeze Layer

This command will freeze layers by picking entities on that layer. The entity selection is done by selection set for selecting one or more entities.
Prompts

Select entities on layers to be frozen.
Select objects: pick entities
Pulldown Menu Location: View
Keyboard Command: loff
Prerequisite: None

Isolate Layer

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

Prompts

Select objects on layers to isolate.
Select objects: pick entities
Retain POINT layers [Yes/No]? Press Enter

Isolate the wall layer by picking one wall line

Pulldown Menu Location: View
Keyboard Command: isolate
Prerequisite: None

Restore Due North

This command twists the screen to make due north vertical.

Pulldown Menu Location: View > Twist Screen
Keyboard Command: twist4
Prerequisite: None

Restore Layer

This command thaws the layers that were frozen by the Isolate Layer command.

Pulldown Menu Location: View
Keyboard Command: restore
Set Layer
This command allows the user to change the current layer to a different layer by picking an entity on that layer.

Pulldown Menu Location: View
Keyboard Command: lset
Prerequisite: None

Freeze Layer
This command will freeze layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are frozen.

Prompts
Pick entity on layer to be frozen: pick an entity
Freezing layer
Pick entity on layer to be frozen (U-Undo, Enter to end): press Enter

Pulldown Menu Location: View
Keyboard Command: pickoff
Prerequisite: None

Surface 3D Viewer
This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in 3D Viewer Window appears.
Freeze Layer

This command will freeze layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are frozen.

Prompts

Pick entity on layer to be frozen: pick an entity
Freezing layer
Pick entity on layer to be frozen (U-Undo, Enter to end): press Enter

Thaw Layer

This command thaws the layers frozen by the Freeze Layer command.

Set UCS to World

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson command work exclusively in the world coordinate system. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

Twist Screen: Standard

This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as Rotate Points and Translate Points, if you want to do a coordinate rotation or translation.

Prompts

This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of the DVIEW command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.
Twist Screen: Line Pline or Text

This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

Prompts

Pick a line, polyline or text to make horizontal: pick a line or polyline

Twist Screen: Surveyor

This command is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen. Entering zero would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen. The Grid Projection Angle button prompts for a base point and sets the angle to the grid mapping angle. To use this option, the grid projection must be assigned in the Drawing Setup command.

Twist To 3D View

This command orients selected text, symbols and point attributes to face the current viewpoint. Typically, text and points are drawn to face up to plan view. When viewed in 3D from the side, this text can be hard to read. This command makes this text readable for the current view. Before running this command, the 3D view should be set by commands like Viewpoint 3D or Orbit. The entities are oriented to the current view by setting the extrusion.
values for the entities.

**Prompts**

Select points, symbols and text to twist.
Select objects: pick entities
Pulldown Menu Location: View > Twist 3D Entities
Keyboard Command: twist3d
Prerequisite: Entities to view

**Restore World View**

This command is the companion to the Twist To 3D View command. This command resets entities so that they face up in plan view.

**Prompts**

Select points, symbols and text to restore.
Select objects: pick entities
Pulldown Menu Location: View
Keyboard Command: untwist3d
Prerequisite: 3D Entities

**Display Order by Layer**

The Display Order by Layer command provides a handy method to quickly restore proper visibility to entities in a drawing when they become obscured by other entities (such as hatch patterns or raster image backgrounds). This command provides a combination of the popular *Send to Back* (draworderb) and *Bring to Front* (draworderf) routines (also found under the View(Display Order menu). The display order is applied to the current entities in the drawing at the time the command is run. It does not operate on newly created entities. So you need to run this command each time you want to apply the display order. The following dialog box appears:
Available Layers: The list of layers that are available in the current/active drawing.

Bring to Front: The layers to which the Bring to Front routine will be applied.

Send to Back: The layers to which the Send to Back routine will be applied.

Control Action
Moves the selected layer(s) in the Available Layers group to either the Bring to Front group or the Send to Back group.

Moves the selected layer(s) from either the Bring to Front group or Send to Back group to the Available Layers group.

Promotes the selected layer(s) within the Bring to Front group or Send to Back group.

Demotes the selected layer(s) within the Bring to Front group or Send to Back group.

Allows the layer of a graphically selected entity to be assigned to either Bring to Front group or Send to Back group.

Navigation Controls

OK: Sets the display order to the layers in the drawing according to their rank and classification.

Cancel: Does not retain any layer rank or classification changes and does not commit any changes to entities in the drawing.

Load: Allows a previously saved Layer Order (.LO) file to be loaded into memory.

Save As: Saves the current layer rank and classification to a Layer Order (.LO) file.

Note:

- Layers that remain in the Available Layers category remain neutral.
- Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple layers at the same time.
Zoom Points

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

Prompts

Find by point number or description [<Number>/Desc]? N
Point number or range of point numbers to find <1>: 2079
We want to find point number 2079
Magnification or Height <179.50>: press Enter
Accept the default zoom magnification

Pulldown Menu Location: View
Keyboard Command: zoompnt
Prerequisite: A .CRD file

Zoom Selection

This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use Zoom Selection to select the entities of one of these dots and quickly zoom the display to these entities.

Prompts

Select objects to zoom onto:
Select objects: select entities

Pulldown Menu Location: View
Keyboard Command: zoom_on
Prerequisite: Entities

Thaw/On All Layers

This command turns on and thaws all layers in the drawing.

Pulldown Menu Location: View
Keyboard Command: loa
Prerequisite: None

Lock Layers

The Lock Layers command will lock the layers for the layers of the selected entities.

The Unlock Layers command will unlock the layers for the layers of the selected entities.
Save/Restore Layer State

The *Save Layer State* command stores to a file all the layers in the drawing and their current status of color, freeze/thaw, on/off, and linetype. The layer state file has a .LAY extension. Later versions of AutoCAD include the ability to save and restore layer states, found in the layer dialog box.

The *Restore Layer State* command sets the drawing layers and their status from the layer information in a layer state file (.LAY file). If a layer from the layer state file does not exist in the drawing, the program will create the layer. Besides the Carlson format, the Land Desktop layer state format, which is also uses a .LAY extension, is supported by this command.

**Pulldown Menu Location:** View  
**Keyboard Command:** savelay, restlay  
**Prerequisite:** None

**Draw Menu**

Many of the Draw Menu commands are CAD commands for creating entities in your drawing. Carlson commands that are part of the Draw menu are documented here. Any items not appearing in the Carlson manual are CAD commands that can be referenced in the AutoCAD or IntelliCAD manual.
2D Polyline

A Polyline is a complex CAD entity comprised of one or more line and/or arc segments. One way to draw a polyline is to use the Command: line, pulldown menu or toolbar to execute the standard CAD command PLINE. While its elevation isn’t necessarily zero, a polyline is 2-dimensional or flat.

The Carlson version of the PLINE command, 2D Polyline, is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (2DP) and provides many more options than the standard CAD version of the command. Unless disabled, the Polyline 2D Options dialog box will appear after starting Carlson's 2D Polyline command.

Show Options on Startup: When this option is enabled, the Polyline 2D Options dialog box will display automatically upon starting the 2D Polyline command. If disabled, the command runs strictly from the Command: line.

Elevation: Set the elevation of the polyline to be drawn.

Offset from Centerline: If this option is enabled, an additional option, Offset, is available from the Command: line. Issuing the "Offset" option allows you to draw a new polyline using Station and Offset entry from an existing polyline or existing Centerline (.CL) file.

Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 2D Polyline segment.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

Annotate Closed Pads: Enabling this option will activate the "Settings" button. The "Settings" button displays the Label Pad Elevations dialog box where you can specify label settings for the pad and other vertical offset elevations. For instance, you can label both the Finished Floor Elevation and the SubGrade elevation of a building pad at the same time using this command. See additional information on the Label Pad Elevation command.
In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

**Use Current Drawing Properties**: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

**Layer**: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

**Set Color**: Use this button to manually specify a color for the newly created polyline.

**Width**: Specify the width of the newly created polyline.

**Linetype**: Use the "Select" button to manually specify a linetype for the newly created polyline.

**Select Code**: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the **Point Defaults** dialog box.

**Prompts**

**Command**: `2dp`

[Continue/Extend/Follow/Offset/OPtions/<Pick point or point numbers>]: screen pick a point

[Arc/Clo/Close/Distance/Follow/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 202.55, Total length: 202.55

[Arc/Clo/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 179.73, Total length: 382.28

[Arc/Clo/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 127.45, Total length: 509.73

[Arc/Clo/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter
Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets < Default >.

Continue: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:”, you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

Extend: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:”, you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]

I - Input mode - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.
R - Right rotate - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.
L - Left rotate - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.
S - Switch direction - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.
T - Total distance - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 2D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.
A - Angle change - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.
B - Bearing/Azimuth/Turned/Deflection - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.
E - Extend to edge - Extends current segment to another line or entity
U - Undo - Undo last action
X - Quit extend mode - Returns to normal 2D Polyline Draw mode
Help - Displays the descriptions of the Extend options
Enter or Pick Distance - Distance to extend the current segment

Follow: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". With this being a 2D Polyline, the answer to this is most likely "NO". You will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

Offset: With the "Offset" option, you will first be prompted to select an existing polyline or select an exist-
ing Centerline (.CL) file. Next, you will be asked to "Specify starting station:" where you will enter the station number of the first polyline vertex. Then, you will be prompted to "Enter Station" and "Enter Offset" for each vertex of the new polyline. Note: To have this option available, you must place a check next to Offset From Centerline in the Polyline 2D Options dialog box.

**Pick Point or Point Numbers:** This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

**Arc/Line:** New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

**Close:** This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

**Distance:** This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

- **Cursor** - This method will draw the polyline segment in the direction of your cursor position.
- **Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.
- **Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo:** Undo the last drawn polyline segment.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

**Pulldown Menu Location:** Draw
**Keyboard Command:** 2DP
**Prerequisite:** None

---

### 3D Polyline

A 3D Polyline is a specialized version of a polyline that can have different elevation at every vertex.

The **3D Polyline** command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (3DP). Unless disabled, the Polyline 3D Options dialog box will appear after starting Carlson's 3D Polyline command.
**Show Options on Startup:** When this option is enabled, the Polyline 3D Options dialog box will display automatically upon starting the 3D Polyline command. If disabled, the command runs strictly from the Command: line.

**Prompt for Elevation/Slope:** When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

**Prompt for Coordinate Point Elevations:** This option only applies if you specify a point number from an associated Coordinate (.CRD) file to establish the X,Y,Z values for a new 3D Polyline vertex. When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

**Elevation Adder:** Use this setting to add a constant elevation value to all default elevation values.

**Check Elevation Range:** Enabling this option allows you to monitor elevations assigned to 3D Polyline vertices and issue a warning (with options to correct) if the elevation falls outside the specified range. If the proposed elevation of a 3D Polyline vertex falls outside the range specified, the **Warning: Elevation Range** dialog box is displayed. The **Warning: Elevation Range** dialog box allows you to assign a new elevation to the vertex, adjust the acceptable range of elevations or turn OFF monitoring of elevations.

**Use Surface Model From File:** Selecting this option allows you to use a Surface Model (.TIN, .GRD, .FLT) file to determine the elevation for each new 3D Polyline vertex.
Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 3D Polyline segment.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

Use Current Drawing Properties: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

Layer: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

Set Color: Use this button to manually specify a color for the newly created polyline.

Width: Specify the width of the newly created polyline.

Linetype: Use the "Select" button to manually specify a linetype for the newly created polyline.

Select Code: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

Prompts

For A 3D Polyline With A Specified Elevation At Each Vertex:
Command: 3dp
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: screen pick a point
Interpolate/Object/<Elevation> <0.00>: 150.50
Z: 150.50
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation/<Interpolate>: 155.25
Z: 155.25, Hz dist: 324.63, Slope dist: 324.66, Slope: 1.5% Ratio: 68.3:1
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation/<Interpolate>: 148.12
Z: 148.12, Hz dist: 272.88, Slope dist: 272.98, Slope: -2.6% Ratio: -38.3:1
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
Command:

For A 3D Polyline With Interpolated Elevations At One or More Vertices:
Command: 3dp
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: screen pick a point
Interpolate/Object/<Elevation> <0.00>: 91.73
Z: 91.73
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation/<Interpolate>: screen pick a point

Chapter 2. General Commands 157
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnap[.]/Next point or elevation <Interpolate>: 94.44
Z: 94.44, Hz dist: 79.39, Slope dist: 122.88, Slope: 0.8% Ratio: 122.4:1
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
Command:

Note that the difference between this and the previous example is that, instead of entering an elevation for each vertex, we are screen picking another new vertex. Each time we neglect to enter an elevation we are notified that, "This point elevation will be interpolated upon completion." After we specify "94.44" as the elevation of the last vertex, the slope of the interpolated segments is calculated using the total elevation change and the total length of all interpolated segments. Now, the elevations of all vertices can be determined and set based on the resulting slope.

Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets <Default>.

When starting a new 3D Polyline, the initial set of options assist you in setting the X,Y location of the first vertex:

Continue: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

Extend: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]}

I - Input mode - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.
R - Right rotate - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.
L - Left rotate - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.
S - Switch direction - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.
T - Total distance - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 3D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.
A - Angle change - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a
specified angle and then prompts for a distance.

**B - Bearing/Azimuth/Turned/Deflection** - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**E - Extend to edge** - Extends current segment to another line or entity

**U - Undo** - Undo last action

**X - Quit extend mode** - Returns to normal 3D Polyline Draw mode

**Help** - Displays the descriptions of the Extend options

**Enter or Pick Distance** - Distance to extend the current segment

**Follow**: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". After answering Yes or No, you will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

**Options**: This will display the **Polyline 3D Options** dialog box.

**Pick Point or Point Numbers**: This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

After setting its location, the next set of options help you calculate the elevation of the initial vertex:

**Interpolate**: This option will set the elevation of the vertex by calculating the slope between other vertices of known elevation.

**Object**: This option allows you to "Select an elevation label or a point on a polyline:" to set the elevation of the vertex. Elevation labels such as "FFE: 124.85" or "Z: 124.85" can be selected.

**Elevation**: This is the default option and prompts you to type in the elevation for the vertex.

For subsequent 3D Polyline vertices, several options are added to assist you in setting the X,Y location of each new vertex:

**Arc/Line**: New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

**Close**: This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

**Distance**: This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

**Cursor** - This method will draw the polyline segment in the direction of your cursor position.

**Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.

**Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo**: Undo the last drawn polyline segment.

After setting subsequent vertices, several more options are added to help you calculate the elevation of each vertex.
Percent: This option allows you to specify the slope in Percent format (3%) from the previous vertex.
Ratio: This option allows you to specify the slope in Ratio format (for 3:1, enter 3) from the previous vertex.
Degree: This option allows you to specify the slope angle in decimal degree format (dd.dddd) from the previous vertex.
Osnap[.]: Using the [.] will toggle Running OSNAP settings ON or OFF.

Angle Entry Methods
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

Pulldown Menu Location: Draw
Keyboard Command: 3DP
Prerequisite: None

3 Point
This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either be picked on-screen or specified by point number.

Prompts
Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3PA
Prerequisite: None

PC, PT, Radius Point
This command draws an arc between the PC point, radius point and PT point. The points can either be picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts
Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N

Pulldown Menu Location: Draw > Arc
Keyboard Command: pca
Prerequisite: None

**PC, PT, Radius Length**

This command draws an arc that is defined by the specified PC point, PT point and radius length. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

**Prompts**

Pick PC point or point number: pick a point
Radius length: 300
Pick PT point or point number: pick a point
Is the direction of this arc correct [<Yes>/No]? press Enter for Yes

Pulldown Menu Location: Draw > Arc
Keyboard Command: pcptr
Prerequisite: None

**PC, PT, Tangent**

This command fits a curve between beginning and end points (PC, PT) given a tangent-in. The tangent-in is specified by selecting a line entity. The PC and PT points are screen picked.

**Prompts**

Pick tangent-in: pick a line entity
Pick point PC: pick a point
Pick point PT: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: tangpcpt
Prerequisite: Tangent line

**PC, Radius, Chord**

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or
counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other
direction, enter No.

Prompts

Radius of Arc <-40.00>: 500
PC Start Point ?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d10'41")
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcb
Prerequisite: None

PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked
on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise.
The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00>: 150
Is this arc in the correct direction (<Yes>/No)? press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then
prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.000>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlin
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick
the P.I. (intersection of tangent lines) and points on the two tangent lines.
### Prompts

**Arc Length** $<100.00>$: press Enter or enter distance  
[int on] Pick P.I. of curve: pick intersection of tangent lines  
[nea on] Pick pnt on 1st Tangent Line: pick a point  
[nea on] Pick pnt on 2nd Tangent Line: pick a point

**Pulldown Menu Location:** Draw > Arc  
**Keyboard Command:** 2tanlal  
**Prerequisite:** Tangent lines should be drawn before execution

### 2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

**Prompts**

**Chord Length** $<100.00>$: press Enter  
[int on] Pick P.I. of curve: pick a point  
[nea on] Pick Point on 1st Tangent Line: pick a point  
[nea on] Pick Point on 2nd Tangent Line: pick a point

**Pulldown Menu Location:** Draw > Arc  
**Keyboard Command:** 2tanlcl  
**Prerequisite:** Tangent lines should be drawn before execution

### 2 Tangents, Mid-Ordinate

This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.

**Prompts**

**Middle Ordinate** $<50.00>$: press Enter  
[int on] Pick P.I. of curve: pick a point  
[nea on] Pick Point on 1st Tangent Line: pick a point  
[nea on] Pick Point on 2nd Tangent Line: pick a point
2 Tangents, External

This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: *pick a point
[nea on] Pick Point on 1st Tangent Line: *pick a point
[nea on] Pick Point on 2nd Tangent Line: *pick a point
External Distance <50.00>: *press Enter

2 Tangents, Tangent Length

This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.

Prompts

Tangent Length <50.00>: *press Enter
[int on] Pick P.I. of curve: *pick a point
[nea on] Pick Point on 1st Tangent Line: *pick a point
[nea on] Pick Point on 2nd Tangent Line: *pick a point

2 Tangents, Degree of Curve

This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.

Prompts

Degree of Curve (ddd.mmss) <5.0000>: *press Enter
Define by [C]hord or [A]rc length <A>: *press Enter
[nea on] Pick Point on 1st Tangent Line: *pick a point
[nea on] Pick Point on 2nd Tangent Line: *pick a point
2 Tangents, Through Point

This command creates an arc by tangents in/out plus a pass through point on the arc.

Prompts

Pick tangent-in: pick a line entity
Pick tangent-out: pick another line entity
Pick point on the arc: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanpt
Prerequisite: 2 tangent lines

Tangent, PC, Radius, Arc Length

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point ?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc 14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: sral
Prerequisite: Tangent lines should be drawn before execution

Tangent, PC, Radius, Tangent Length

This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.
Prompts

Precede radius with - sign for curve to the right.
Radius of Arc \(<300.0000\)?: press Enter
Tangent Length \(<236.0000\)?: press Enter
PC Start Point?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5270.39 4840.36 0.0)
Radius Point Coordinates: (5251.37 4534.71 0.0)
Pulldown Menu Location: Draw > Arc
Keyboard Command: srcl
Prerequisite: Tangent lines should be drawn before execution

Tang, PC, Radius, Chord Length

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc \(<300.0000\)?: press Enter
Chord Length \(<25.0000\)?: press Enter
PC Start Point?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)
Pulldown Menu Location: Draw > Arc
Keyboard Command: SRCL
Prerequisite: Tangent lines should be drawn before execution

Tang, PC, Radius, Delta Angle

This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.
Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution

Arc From Last Point
This command draws an arc that is tangent from the last point of the most recent linework or arc entity. The PC point of the arc is automatically set from this last point. This command only prompts for the PT point to create the arc.

Prompts

Specify end point of arc: _DRAG pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: arc
Prerequisite: Linework

Compound or Reverse
This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)

Reverse curve off an existing curve

Prompts

[end on] Select ARC at PC Start point of the curve: pick a point
Type of curve [<Compound>/Reverse]: press Enter
Enter the Radius: 300
Define arc method [Tangent/Chord/Delta/<Length>]: press Enter
Enter the arc length: 236

Pulldown Menu Location: Draw > Arc
Keyboard Command: srer
Prerequisite: Tangent arc should be drawn before execution

3-Radius Curve Series
This command is used to best fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents" is the distance perpendicular to the tangent from both ends of the second curve.

Offset from the tangents is the x value

Prompts

Please pick two tangents...
Pick first tangent: pick a point
Pick second tangent: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3curves
Prerequisite: Two tangents

Best Fit Curve
This command draws an arc between two endpoints with a radius that is derived from sampling points. Least-squares is used to find the radius for the closest arc that passes through these points. After specifying the points, the program calculates the best-fit arc and shows the results in the dialog show here. You can toggle each point for...
whether to include in the calculations. When a point is toggled off for processing, it is not used to calculate the best-fit arc but the residual is still reported. Use the Remove button to remove a point both from calculation and reporting. You can also modify the radius. After picking OK, the arc is drawn in the current layer and there is a report.

**Prompts**

**Starting Point ?**  
Pick point or point number: 46

**Ending point ?**  
Pick point or point number: 50

Select points from screen, group or by point number [ <Screen>/Group/Number]? press Enter

Select Carlson Software Points.

Select objects: W Use window to select a group of points. After selecting all the points to sample, end selection by pressing Enter.

```
Best Fit Arc
Coordinate File > C:\sample\PLAT.CRD

Source Coordinates  
Point# Northing Easting Residual  
46 4573.478 5647.688 -0.059  
47 4518.180 5667.428  0.177  
49 4669.960 5671.494 -0.211  
50 4707.039 5664.138  0.093

Residuals Standard Deviation: 0.148
Average Residual: 0.135

Circle Center: 4657.233,5516.647
Radius: 155.580

Pulldown Menu Location: Draw > Arc  
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.
```
Curve Calc

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.

![Curve Calculator dialog](image)

**Roadway or Railroad:** Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

**Select:** Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

**3 Points:** Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

**Plot:** Allows you to plot the currently defined arc in the drawing.

**Clear:** Clears all edit boxes in the dialog.

### Prompts

**Curve Calculator dialog** *Enter at least two values, as described above*

The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the *Enter* or *Tab* key.

**Pulldown Menu Location:** Draw > Arc

**Keyboard Command:** curvcalc

**Prerequisite:** None

### Spiral Curve

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the *Calculate Offsets*,

---

*Chapter 2. General Commands*
Station Polyline/Centerline or Offset Point Entry commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.

Prompts

Spiral method [TS/ST/＜PI＞] press Enter
PI Point ?
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24'9" E Azimuth= 56d24'9"
Tangent out direction= S 65d9'1" E Azimuth= 114d50'59"
Overall Delta= 58d26'50"
Point calculating distance resolution ＜10.0＞: press Enter
Length of Spiral ＜350.0＞: press Enter
Radius of simple curve (precede with - sign if curve to left) ＜954.93＞: 954.93
Degree of curve: 6°0’0’’
Theta of Spiral= 0.18325951 (radians) 10d30'0'' (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) ＜P＞: press Enter
Point calculating distance resolution ＜10.0＞: 5 Enter the resolution at which you would like the line segments of the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
＜press [Enter] for symmetrical spiral out＞/[D]elta of simple curve: press Enter If you want a spiral in only enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26'50" Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pulldown Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the tangent line in or out.

Field Text
This command adds predefined and custom text objects to your drawing that are updated when a drawing is Regenerated or Saved. Custom fields refresh their data from the Custom Properties defined in the Layout Manager. For example, one of the available fields is Layout Page Number which can be placed as a text entity on a layout. Then if the layout page number changes, the text is updated.
**Category**: The Category list is used to filter the Available Fields. Selecting All will show all Categories. Some Categories, such as Current Layout Set, Current Layout Subset and Current Layout will only be displayed if the current drawing is attached to a Layout Set file (.set).

**Add**: Use the Add button to add an Available Field to the Selected Fields list. As you add fields sequentially to the Selected Fields list, the name and row number will be displayed. You can change the row number if you would like the field to appear on a new line. See the Setup button description for more information.

**Remove**: Use the Remove button to remove a field from the Selected Fields list.

**Setup**: Use the Setup button to edit the Prefix, Suffix and other contextual properties of the field. For example, Date fields will show a Date Format option, and numeric fields may show a precision format option. Toggle the "Place on new row" checkbox to place the field on a new line. The Field Setup dialog can also be invoked by double clicking a Selected Field list item.

**Move Up**: Use the Move Up button to move the selected field above the previous field.

**Move Down**: Use the Move Down button to move the selected field below the next field.

**Draw Field As**: These radio buttons will specify whether the Field is drawn as Text or MText objects.
Multileader with Text
This command draws multiple leaders to a label. The style of the leaders is controlled by the current Dimension Style.

Prompts

Beginning point of leader: Pick point at arrowhead
End point for leaders: Pick point at label
Text: Multileader
Text (Enter to end): press Enter
Beginning point of leader (Enter to end): pick a point
Beginning point of leader (Enter to end): press Enter

Text on Line
This command creates text aligned by the selected linework. In the options dialog, you set the text string to create, height, justification and text entity type. The Text Offset controls the distance between the linework and the text. The Slide option allows you to graphically place the text.
Prompts

Create Text on Line dialog
Pick line or polyline segment: select linework entity
Pick point for slide: pick a point

Pulldown Menu Location: Draw > Text
Keyboard Command: textline
Prerequisite: polyline or line

Text Import
This command reads a text file and draws the contents as text entities. The file to import and the options are set in the dialog show here.
Text Export

This command writes a text file from the selected Text and MText entities. The text is sorted to output in top to bottom order based on the entity locations.

Pulldown Menu Location: Draw
Keyboard Command: textin
Prerequisite: text file

Draw Box Around Text

This command draws a rectangle to enclose the selected text. This rectangle is drawn as a polyline in the current layer. The options dialog has Gap Factor which controls the offset from the text to the polyline. The factor is relative to the text size. The Round Corners option fillets the corners of the box.

![Draw Box Around Text](image)

Prompts

[Options/<Select text>]: pick the text to box or type O for the options dialog.

Pulldown Menu Location: Draw > Text
Keyboard Command: textbox
Prerequisite: Text entity

Text Mask

This command hides drawing entities under text by creating a wipeout entity around the text. The Offset is a distance in drawing units to create a buffer around the text.

![Text Mask](image)

Prompts

Select text to mask.
Select entities: pick text
**White Solid Behind Text**

This command draws a white solid rectangle to highlight the selected text. The display order for the solid is set behind the text and the solid is drawn on the current layer. This command is only useful when the text itself is not white.

**Prompts**

**Select text:** *pick the text to highlights*

**Trim Linework Through Text**

This command trims linework that crosses text. After selecting the text to trim with and entering a buffer offset around the text, the program automatically finds any crossing linework and trims.

**Prompts**

**Select text:** *pick the text to trim with*

**Enter gap <0.5>:** *press Enter*

**Insert Symbols**

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the *Edit Symbol Library* command.

In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation. The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and
size. The Prompt For Attributes option applies to symbols that have attribute definitions. When active, this option will prompt for the attribute values in a dialog.

The Select Code option is an alternate way of selecting the symbol by Field-to-Finish code name. The Field-to-Finish code table to use is set with the Points->Point Defaults command. Besides setting the symbol name, the code lookup method also sets the layer. For example, instead of picking a symbol like SPT5 and setting the layer name to "TRAVERSE" for an iron pin symbol, the select code method would set the symbol name and layer by picking the code name/description of "IPS"/"Iron Pin Set" from the code list. So the code method is a way to handle drawing standards.

After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering a easting, northing and elevation in x,y,z order.
Chapter 2. General Commands

Appear at start of command

Appear when Select (symbol) is chosen

Select entities dialog box
### Prompts

**Insert Symbols dialog** Choose parameters and click OK  
Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point  
Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.  
Options/Select entities/Enter coords/<Pick point or point numbers>: 5  
**Insert Symbols dialog**  
Select arcs, faces, points, text, lines and polylines. select objects  
Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end  

**Pulldown Menu Location:** Draw > Symbols  
**Keyboard Command:** ptsym  
**Prerequisite:** None

### Insert Multi-Point Symbols

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The **Insert Multi-Point Symbols** command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.

Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing **Draw Field to Finish** under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pnts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, let's go through the **Insert Multi-Point Symbol** command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Let's look at the BLD code three point insertion definition.
Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The three point PAD and the tree with drip line examples follow. We start by specifying the building pad codes.

**Prompts**

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

Specify LTFNT PAD point.
Pick Point or Point Number (Enter to End): 15
Specify LT REAR PAD point.
Pick Point or Point Number (Enter to End): 16
Specify RT REAR PAD point.
Pick Point or Point Number (Enter to End): 17
Insert another BLD symbol [<Yes>/No]? N

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

Specify Trunk Location point.
Pick Point or Point Number (Enter to End): 1
Specify Drip Line Point.
Pick Point or Point Number (Enter to End): 13
Insert another TREE symbol [<Yes>/No]? N

From the Field to Finish routine

---

Chapter 2. General Commands 180
Chapter 2. General Commands

### Define Symbol Placement Points

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>0.000</td>
<td>TRC</td>
</tr>
<tr>
<td>0.500</td>
<td>0.000</td>
<td>DL</td>
</tr>
<tr>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
</tbody>
</table>

### Insert Multi-Point Symbol

Field to Finish Code Definitions

<table>
<thead>
<tr>
<th>CODE</th>
<th>FULL NAME</th>
<th>SYMBOL</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIKE</td>
<td>Bike Rack</td>
<td>SPT71</td>
</tr>
<tr>
<td>CCB</td>
<td>Curb Stop</td>
<td></td>
</tr>
<tr>
<td>CRATEC</td>
<td>Circular Grate</td>
<td></td>
</tr>
<tr>
<td>MB</td>
<td>Mail Box</td>
<td></td>
</tr>
<tr>
<td>MSBT</td>
<td>Set Brass Tag</td>
<td>SPT4</td>
</tr>
<tr>
<td>TRC</td>
<td>Conifer</td>
<td>SPT53</td>
</tr>
<tr>
<td>TRD</td>
<td>Tree Deciduous</td>
<td>SPT52</td>
</tr>
<tr>
<td>V</td>
<td>Conc Pad</td>
<td></td>
</tr>
</tbody>
</table>

Symbol Size: 10.000

Symbol Layer: 0

- Two points symbol placement for TREE
- Three points for building PAD
Two point tree with drip line

Pulldown Menu Location: Draw > Symbols
Keyboard Command: multisym
Prerequisite: Field to Finish file (.FLD) with codes defined with Multi-Point Symbols

Draw Standard Item

Overview Draw Standard Items

The CAD Standards feature in Carlson Software is a collection of commands allowing you to create, manage and draw standardized Symbols, Linework and Annotation entities that are stored in a Standards Database file (.sdb). All of the commands can be found under the Item sub-menu of the Draw menu or on the Draw Item toolbar.

The Draw Item toolbar, shown below, has icons for the Draw Item, Set Data Source and Exit Drawing Standards commands. In addition, these commands are all accessible from the Draw menu. The Item Standards Manager command is only accessible through the Draw menu.

The Item Standards Manager command launches the Standards Draw Manager palette. This palette has a right-click shortcut menu allowing you to Insert, Modify, Delete and otherwise manage Items stored in the Standards Database file (.sdb). Other than the shortcut menu, this palette is identical to the Standards Draw palette.

The first time you launch the Item Standards Manager in a drawing session, you will be prompted to "Select Drawing Standards Data Source". Carlson includes two Standards Database files (.sdb) with the installation: the Carlson NCS SurveyCivil.sdb which is a fully populated database based on the US National CAD Standard and empty.sdb which is a functional, but empty, database with which to start a new Standard Database. Updates and additions to the .sdb files provided by Carlson Software will be posted to this website: www.carlsonsw.com/cadstandards.html.
Using the **Draw Standard Item** command, the CAD User can access the **Standards Draw** palette and place standardized Symbols, Linework and Annotation in the drawing. Prior to adding Standard Items to the drawing, the CAD User will load the appropriate Standards Database file (.sdb) using the **Set Data Source** command.

Pulldown Menu Location(s): Draw > Draw to Standard

Keyboard Command: Varies

Prerequisite: Varies

### Draw Standard Item

The **Draw Standard Item** command activates the **Standards Draw** palette. This palette is essentially the same as the **Standards Draw Manager** palette except that it does not have the Standards management commands available in the right-click shortcut menu.

The first time you launch the **Draw Standard Item** command in a drawing session, a dialog box will prompt you to "Select Drawing Standards Data Source".

The Standards Data Source can be loaded by specifying a Universal Data Link file (.udl) or a Standards Database file (.sdb). Carlson includes two Standards Database files (.sdb) with the installation: the *Carlson_NCS_SurveyCivil.sdb* which is a fully populated database based on the **US National CAD Standard** and *empty.sdb* which is a functional, but empty, database with which to start a new Standard Database. Updates and additions to the .sdb files provided by Carlson Software will be posted to this website: [www.carlsonsw.com/cadstandards.html](http://www.carlsonsw.com/cadstandards.html).

After specifying the data source, the **Draw Standard Item** command is automatically issued. If you wish to Draw a Standard Item in your drawing at this time, you can specify the Standard Item to be drawn either by typing its QuickKey in at the Command: Line or by selecting a similar Standard Item currently existing in the drawing.

If you do not know the QuickKey of the Standard Item you wish to draw and do not have a similar Item in the drawing, press the **Enter** key to finish the command and return to the Command: prompt. You can now access the **Standards Draw** palette by hovering over the **Draw Standard Item** icon on the **Draw Item** toolbar.

By default, the **Standards Draw** palette automatically hides within the **Draw Standard Item** icon. Hovering over this icon will display the palette. Once displayed, the palette may be dragged to a new location and re-sized. Since the palette is fully transparent, it can be "parked" in the drawing area and not interfere with other drafting tasks. The palette is also "transparent" with regards to command execution in that other commands are able to run while the palette remains open and available for use.
Items in the **Standards Draw** palette are organized into Folders and given commonly referred-to, descriptive names. Defining these Items and other management tasks are done through the **Items Standards Manager**.

A Standard Item can include any one or a combination of 3 types of entities: Symbols, Linework and Annotation (with or without a Leader). Next to each Item in the palette is an icon graphic that indicates the type of entities defined for that Standard Item.

This icon, ![Standard Symbol Item](image) is shown for a Standard Symbol Item.

This icon, ![Standard Linework Item](image) is shown for a Standard Linework Item.

This icon, ![Standard Annotation Item](image) is shown for a Standard Annotation Item.

You may also see one of these icons representing a combination of entity types: ![Combined Icon](image)

Because many Standard Items will be sized based on the scale of the drawing, it is important to set the "Horizontal Scale" in the **Carlson Drawing Setup** dialog box before drawing Standard Items into your drawing. If Standard Items are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Symbols, Annotation and Leader components.

There are 3 methods you can use to place Standard Items in your drawing:

- **Select Object** - This option is enabled when starting the **Draw Item** command from either the **Draw Item** toolbar or the **Draw** menu. When prompted at the Command: Line, you can select any Standard Item that has been previously drawn in the drawing and will then be able to place a new instance of that Item.
- **Quick Key** - This option is enabled when starting the **Draw Item** command from either the **Draw Item** toolbar or the **Draw** menu. When prompted at the Command: Line, type in the QuickKey shortcut for the Standard Item you wish to draw.
- **Standard Draw palette** - After the Data Source has been loaded, you can access the **Standard Draw** palette...
To Draw a Standard Item using the Item menu in the palette, navigate through and left-click the Standard Item to be drawn. Assuming the Standard Item has a Symbol, Linework and Annotation component, you will see, generally, the following series of prompts. Note that, depending on the various options that have been set for each Item, the prompts may vary.

**Start Point:** Using the left-mouse button, select the location for the first Symbol component. This point will also be the first endpoint of the Linework for this Item. If you do not wish to have a Symbol inserted at this point and only wish to draw the associated Linework, hold the **ALT** key when specifying the Start Point to proceed on to the next Endpoint.

**Rotation Angle:** If you have placed a Symbol, specify its Rotation Angle. If you have set the Symbol Rotation option to "Fixed", you will not be prompted for this Rotation Angle.

If you Insert a Symbol having non-Constant attribute values, you will be prompted through a dialog box to define the attribute values:

![Define Attribute Values](image)

**Halfwidth/Width/CClose/LEngth/Open/Undo/Arc Endpoint of line:** Select the next Endpoint of the line segment or specify one of the other Polyline command options before picking the Endpoint. If you do not want to draw a Linework segment at this time, press **Enter** to skip this step and continue on to place Annotation.

**Rotation Angle:** Specify the Rotation Angle for the next Symbol. Again, depending on the Symbol Rotation options you have set, you may or may not receive this prompt.

The prompts will continue to alternate between "Rotation Angle" and "Endpoint of Line" until you have reached the end of your Linework. When you have specified your final Endpoint and the Rotation Angle of your final Symbol, right-click to continue on to place Annotation.

**Displacement/Identify or `<P>` key in alternative text:** This is the prompt for your first Annotation entity. The Item's Label is used for default Text content. To override the default Text, simply type in the alternative Text at the Command: Line. If you need a 2nd line of Text, use "\P" to designate the 2nd line of text. For instance, entering "TWO STORY\PWOOD FRAME" would result in the following Text string in the drawing: TWO STORY WOOD FRAME. Also, left-clicking on any other Text entity will update your current Text value to match the Text that was selected. And, holding the **ALT** key while left-clicking on any other Text entity will add the value of that Text entity as a 2nd line of Text to your current Text value.
Once you have finished entering the Text, press Enter to finish Text entry. Left-click in the drawing to place the Text.

**Rotation angle/Identify or \P>key in alternative text <0.0000>:** Type in a Rotation Angle for the text or left-click to specify the desired angle.

**Leader Start Point:** Left-click to specify the location of the arrowhead part of the Leader. If you do not want a Leader, you can right-click to skip the Leader and proceed on to place the next Text entity.

**Next Leader Point:** Left-click to specify the next Endpoint of the Leader. You will continue being prompted for "Next Leader Point:" until you right-click or Enter to finish drawing the Leader.

After you have finished drawing the first Annotation entity (with or without a Leader), you will continue to be prompted to place additional Annotation and Leaders. Right-click or press Enter to finish the command.

**Pulldown Menu Location(s):** Draw > Draw To Standard

**Keyboard Command:** drawitem

**Prerequisite:** Populated Standards Database file (.sdb)

### Set Drawing Standards Data Source

The **Set Drawing Standards Data Source** command allows you to browse to and associate a Standards database file with your active drawing. Doing so enables you to use the **Draw Item** command to place Standard Items into your drawing.

This command will accept selection of either a Standards Database file (.sdb) or Universal Data Link file (.udl) that points to the .sdb file. Carlson includes two Standards Database files (.sdb) with the installation: the *Carlson_NCS_SurveyCivil.sdb* which is a fully populated database based on the *US National CAD Standard* and *empty.sdb* which is a functional, but empty, database with which to start a new Standard Database. Updates and additions to the .sdb files provided by Carlson Software will be posted to this website: [www.carlsonsw.com/cadstandards.html](http://www.carlsonsw.com/cadstandards.html).

This command is available from the **Draw** menu and the **Draw Item** toolbar as shown below.

**Pulldown Menu Location(s):** Draw > Draw To Standard

**Keyboard Command:** setitem

**Prerequisite:** Standards Database File (.sdb)

### Item Standards Manager

The **Item Standards Manager** command launches the **Standards Draw Manager** palette. This palette has a right-click shortcut menu allowing you to Insert, Modify, Delete and otherwise manage Items stored in the Standards Database file (.sdb). Other than the shortcut menu, this palette is identical to the **Standards Draw** palette.

The first time you launch the **Item Standards Manager** in a drawing session, a dialog box will prompt you to "Select Drawing Standards Data Source".

The Standards Data Source can be loaded by specifying a Universal Data Link file (.udl) or a Standards Database file (.sdb). The .udl file is a file that "points" to an .sdb file. CAD Managers may prefer to allow users access to the database through the Universal Data Link file (.udl). This allows the CAD Manager to limit access to the Standards Database file (.sdb) by storing it in a non-shared location. The CAD Manager can set "read only" or "read/write" permissions for the .udl file so as to limit editing access to the protected data stored in the .sdb file.

Carlson includes two Standards Database files (.sdb) with the installation: the *Carlson_NCS_SurveyCivil.sdb* which is a fully populated database based on the *US National CAD Standard* and *empty.sdb* which is a functional,
After specifying the data source, the CAD Standards feature is launched in "CAD Management" mode and the **Draw Standard Item** command is automatically issued. If you wish to place a Standard Item in your drawing at this time, you can simply continue the **Draw Standard Item** command as usual. However, if you need to perform any management tasks to the database, use the **Enter** key to finish the command and return to the Command: prompt. You can then access the **Standards Draw Manager** palette by hovering over the **Draw Standard Item** icon on the **Draw Item** toolbar.

By default, the **Standards Draw Manager** palette automatically hides within the **Draw Standard Item** icon. Hovering over this icon will display the palette. Once displayed, the palette may be dragged to a new location and re-sized. Since the palette is fully transparent, it can be "parked" in the drawing area and not interfere with other drafting tasks. The palette is also "transparent" with regards to command execution in that other commands are able to run while the palette remains open and available for use.

Once displayed, right-clicking inside the **Standards Draw Manager** displays a menu containing the Standards Database management commands.

**New Item Folder**

Use this command to create a new folder or sub-folder in which to store Standard Items.
**Name:** The common name for Items in this Folder. The Folder Name is limited to 32 characters.

**Description:** Additional descriptive information about this Folder. The Folder Description is limited to 32 characters.

**Characteristic:** Distinguishing characteristic of this Folder. The Folder Characteristic is limited to 32 characters.

The "Name", "Description" and "Characteristic" of each new Folder can be organized and named using any consistent naming convention that makes sense for your office. The dialog also allows you to specify a "Prefix" and "Suffix" for both the "Description" and "Characteristic" of each new Folder. The "Prefix" and "Suffix" values shown in the example above have been set as parentheses ( ) and brackets [ ]. You can set the Default values for "Prefix" and "Suffix" in **Item Database Preferences**.

**Label:** This is a read-only value defined by combining the Folder Name, Description and Characteristic.

**Quick Key:** This value is not used or set for Folders.

**Scale:** This read-only value displays the current "Horizontal Scale" as specified in **Carlson Drawing Setup**.

### Import Symbol Library

This command allows you to import a collection of blocks into the database as Standard Symbol Items. Default Scale, Attribute Properties and Rotation can be set for all symbols when importing to the database. For this command, all blocks should be saved out to individual Drawing files (.dwg) in a common blocks folder. And, contrary to accepted CAD practice, the blocks should be drawn on their standard layer instead of layer 0.

For instance, according to our standard, symbol SSWR-08 should reside on layer V-SSWR-STRC. If I intend to import this symbol into the database using the **Import Symbol Library** command, the symbol SSWR-08 should reside in its own drawing file named SSWR-08.dwg and should be drawn on layer V-SSWR-STRC in that Drawing file.

Except as noted above with regard to layers, all Symbols should be drawn according to the guidelines set forth in the Best Practices section of this document.
Scale: Because the default X, Y and Z scale factors correspond to the current "Horizontal Scale" setting in Carlson Drawing Setup, these values should all be set to "1" when defining Standard Symbol Items to the database.

Select the "Fixed" options for X, Y and Z Scales if you wish to manage the Symbol size solely by these values. Do NOT select the "Fixed" options if you want the Symbol size to vary depending on the "Horizontal Scale" setting of the drawing.

Properties: For blocks having defined attributes, use the settings here to Allow Moving, Rotating and Masking of attributes.

Rotation: Default Rotation for Symbols can be specified as "First", "Fixed" and "Previous". The "First" option will prompt for a Rotation angle for the first Symbol and then will automatically Rotate all subsequent Symbols to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Symbol. The "Previous" option will prompt for the Rotation angle of each Symbol that is placed, but will default to the Rotation angle of the previously placed Symbol.

Browse for Folder: Browse to and select the folder containing the Symbols to be imported. After importing Symbols from a folder, the database will automatically add the folder to the list of "Additional Support Paths" as specified in the Item Database Preferences. In order to insert the Symbol into other drawings in the future, the source drawing file containing the original Symbol/Block definition must be found in a Support Path.

Export Layer Library

Use this command to export all layers and associated properties (color, linetype, etc.) to a Layer Library file (.la).

Export Field to Finish

Use this command to export all Standard Items to corresponding field codes in a Field to Finish file (.fld).

Insert Item

Use this command to define a Standard Item to the Standards Database file (.sdb). If you wish to store the new Standard Item in a Folder, you must first select and highlight the Folder, then right-click and select Insert Item from the shortcut menu. If you do not want the new Standard Item saved in a Folder, simply right-click anywhere in the palette and select Insert Item. Once Items have been created, you can simply "drag and drop" Items from one Folder to another as needed.

A Standard Item, when defined to the database, can include any one or a combination of 3 types of entities: Symbols, Linework and Annotation (with or without a Leader). If more than one of any type (2 Symbols, for instance) are selected, you will be prompted to select the ONE entity to be used for the Standard Item definition.
Prior to inserting a new Standard Item, all entities should be drawn according to the guidelines set forth in the Best Practices section of this document.

Select Objects: Select the entities that comprise the new Standard Item to be defined.

Name: The common name for this Item. The Item Name is limited to 32 characters.

Description: Additional descriptive information about this Item. The Item Description is limited to 32 characters.

Characteristic: Distinguishing characteristic of this Item. The Item Characteristic is limited to 32 characters.

The "Name", "Description" and "Characteristic" of each new Item can be organized and named using any consistent naming convention that makes sense for your office. The dialog also allows you to specify a "Prefix" and "Suffix" for both the "Description" and "Characteristic" of each new Item. The "Prefix" and "Suffix" values shown in the example above have been set as parentheses ( ) and brackets [ ]. You can set the Default values for "Prefix" and "Suffix" in Item Database Preferences.

Label: This is a read-only value defined by combining the Item Name, Description and Characteristic.

Quick Key: This is a nickname for the Standard Item. The Quick Key is used with the Draw Item command and allows you to specify the Standard Item to be drawn from the Command: line.

Scale: This read-only value displays the current "Horizontal Scale" as specified in Carlson Drawing Setup.

Symbol tab
Scale: Because the default X, Y and Z scale factors correspond to the current "Horizontal Scale" setting in Carlson Drawing Setup, these values should be set to "1" when defining Standard Symbols to the database.

Select the "Fixed" options for X, Y and Z Scales if you wish to manage the Symbol Size solely by these values. Do NOT select the "Fixed" options if you want the Symbol Size to vary depending on the "Horizontal Scale" setting of the drawing.

Properties: For blocks having defined attributes, use the settings here to allow Moving, Rotating and Masking of attributes.

Rotation: Default Rotation for Symbols can be specified as "First", "Fixed" and "Previous". The "First" option will prompt for a Rotation angle for the first Symbol and then will automatically Rotate all subsequent Symbols to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Symbol. The "Previous" option will prompt for the Rotation angle of each Symbol that is placed, but will default to the Rotation angle of the previously placed Symbol.

Linework tab

Linetype: This read-only value reflects the Linetype of the Linework element. Using a "ByLayer" value allows for maximum flexibility in the future.

Scale and Width: The Scale and Width settings shown here reflect the Linetype Scale and Width of the entity selected. These values can be modified and can also be specified as "Fixed".

Select the "Fixed" option for "Scale" if you wish to manage the Linetype Scale of the entity solely by this value. Do NOT select the "Fixed" option if you want the drawing's LTSCALE setting to control the Linetype Scale of each entity.

Note: The "Fixed" option here applies to the Current Entity Linetype Scale and not the global LTSCALE that we are accustomed to changing based on the scale of the drawing. For the LTSCALE to behave in its traditional
fashion, it requires the *Current Entity Linetype Scale* value be set "Fixed" to "1".

Select the "Fixed" option for "Width" if you wish to manage the Width of the entity solely by this value. Do NOT select the "Fixed" option if you want the Width of the linework to be scaled by the "Horizontal Scale" of the drawing.

**Closed:** Select this option if the Linework is to be forced to be a "Closed" polygon.

**Offset Items - Insert:** This button can be used to draw multiple Linework Items parallel to one another. When defining Offsets, you will Insert one Linework Item to the database and then specify the other Linework Items to be drawn parallel to the original Item. The Offset Linework Items do not have to be drawn at the correct Offset. After each Offset Item has been selected, you will be prompted to specify the Offset distance from the original Item.

For instance, in addition to defining separate Standard Items for "Back of Curb", "Gutter Line" and "Edge of Pavement", you might also define a Standard Item named "Standard 30" Curb" that combines all three Standard Items.

First, use the **Insert Item** command and select the "Back of Curb" Item as the first Item.

Next, pick the Offset button and select a "Gutter Line" Item that has been previously drawn in the drawing. You'll be prompted at the Command: Line to specify the Offset Distance from the original Item. This value can also be added or changed in the dialog box. The Offset Distance for the "Gutter Line" would be 0.5, representing a 0.5' wide curb.

Next, pick the Offset button again and select an "Edge of Pavement" Item that has been previously drawn in the drawing. Again, you'll be prompted at the Command: Line to specify the Offset Distance from the original Item. The Offset Distance for the "Edge of Pavement" would be 2.5, representing a 2.5' wide curb with gutter.

After being added as Offsets, both of these values should be marked as "Fixed" because their Offset values should not change based on the "Horizontal Scale" of the drawing.

**Offset Items - Delete:** After selecting an Offset, pick this button to delete the Offset from the Standard Item.
Annotation tab

Style: This read-only value reflects the Text Style of the Annotation element.

Height and Width Factor: The Height and Width Factor settings shown here reflect the Text Height and Width Factor of the entity selected. While both the Height and Width Factor can be modified, the Width of the text is a read-only, computed value. You also have the option of specifying the Height as "Fixed".

Select the "Fixed" option for "Height" if you wish to manage the Height of the entity solely by this value. Do NOT select the "Fixed" option if you want the Height to vary depending on the "Horizontal Scale" setting of the drawing.

Rotation: Default Rotation for Annotation can be specified as "First", "Fixed" and "Previous". The "First" option will prompt for a Rotation angle for the first Annotation entity and then will automatically Rotate all subsequent entities to the same angle as the first. The "Fixed" option will use the Rotation angle as specified for the original Annotation entity. The "Previous" option will prompt for the Rotation angle of each Annotation entity that is placed, but will default to the Rotation angle of the previously placed entity.

Leadered: Select this option if you wish to have the ability to place a Leader with each instance of your Annotation. The Leader option is only available if you selected both a Text/MText entity and a Leader entity when Inserting the Item to the database. The read-only value to the right reflects the Dimension Style of the Leader entity selected.

Mask: Select this option if you wish to have each instance of Annotation "masked" using a WIPEOUT entity. If selected, the "Height Offset" option becomes active allowing you to control the size of the WIPEOUT.

Modify Item

Right-click on any Item or Item Folder and select Modify Item to make changes.

Delete Item

Right-click on any Item or Item Folder and select Delete Item to remove the Item from the database.

Item Database Preferences

Right-click in the palette and select this command to manage Item Description and Characteristic Prefix and Suffix values and also to Add or Delete "Additional Support Paths".
Item Standards Manager - Best Practices

Once Standard Items have been defined to your Standards Database, many properties of those Items cannot be modified. For instance, if you have defined an Annotation entity having a Left justification to your database and later realize it should have Center justification, it cannot be changed. To correct it, you must first delete the Standard Item from the database, create a Text entity with the correct justification and then re-Insert the Item to the database.

Therefore, it is recommended that you create a "Source Drawing" to help you plan, set up and define the Standard Items to be added to your Standards Database.

The Source Drawing should contain small clusters of entities organized according to the Standard Items to be defined. For each Standard Item to be defined, all of the Symbol, Linework and Annotation entities comprising that Item should be drawn or inserted into the Source Drawing.

The Symbols, Linework and Annotation entities used to define Standard Items should be drawn at 1:1 and should have Color and Linetype set to "ByLayer". These entities should reside on their standard layers and be drawn with the appropriate text styles, text heights, text justification, linetypes and dimension styles. Only one type of Standard entity can be defined for a Standard Item. For instance, only one Symbol can be defined per Standard Item.

Before drawing or inserting the components of the Standard Items into the Source Drawing, set the "Horizontal Scale" in Carlson Drawing Setup to 1:1. This ensures that new "Horizontal Scale" settings will be applied correctly when these Standard Items are drawn into new drawings.

A representative sample of a Source Drawing is shown below. A few notes:

- A new Item named "Exis Sanitary Sewer" will be created and will have a Symbol, Linework and Annotation component. The Symbol resides on layer V-SSWR-STRC. The Linework resides on layer V-SSWR-PIPE. The Text and Leader reside on layer V-SSWR-TEXT. Text/MText entities and their associated Leaders are considered ONE Annotation entity when defining to the standards database.

- Notice that the Symbol does not have to be positioned at the endpoint of the Linework when defining as Standard Items. The Symbol will automatically be placed at each vertex of the Linework when it's drawn into the drawing.

- All Text except for that on layer V-SSWR-LABL is drawn with a height of 0.08 and is Left justified. The Text on layer V-SSWR-LABL has a height of 0.12 and is Center justified.

- There are 3 different Symbols to be defined as Items to the database. One may be named, "Exis Manhole", another "Exis Cleanout" and the other "Exis SS Manhole". All 3 Symbols reside on layer V-SSWR-STRC. Note that the same block, the "MH" Symbol, will be defined to the database twice as a component of two different Standard Items - "Exis Sanitary Sewer" and "Exis Manhole".
When being defined, Symbol entities should be drawn at 1:1 (plotted text height).

The Layer of the Symbol entities will be defined to the Standards database; however, because the Color and Linetype of the Symbol were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Symbol Item will follow the Color and Linetype settings of that layer in the new drawing.

Symbols can be defined with or without a Leader.

Symbols and their associated Leaders are considered ONE Annotation entity when defining to the standards database.

Make sure to use the QLEADER command to ensure Symbol and Leader associativity.

The Dim Style of the QLEADER entity will be defined to the Standards database.

Standard Symbol components can be defined having a "Fixed" size or the size can be scaled according to the "Horizontal Scale" of the drawing.

If Symbol components are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Symbols and Leader components.

When defining Symbols/Blocks, it is helpful to include a WIPEOUT entity behind the Symbol so that underlying Linework is hidden without changing its geometry.

Symbol/Block definitions can contain Text and/or Attributes.

When creating a Standard Symbol Item containing Attributes, you can select the options for "Allow Move" and "Allow Rotate" to easily move and rotate each Attribute independently of the other block entities.

Using Attributes inside of Symbol/Block definitions allows for additional data storage in each block. For instance, when Attributes are used, data that is valuable to a GIS can be stored with each Block/Symbol.

When defining Attributes inside Symbol/Block definitions, set the "Constant" flag to keep the Default Value for the Attribute. If the "Constant" flag is not set, you will be prompted for a new Attribute Value each time the Symbol is inserted.

When defining Attributes inside Symbol/Block definitions, use the pipe symbol "—" to provide a drop-down
box with optional Attribute Values. For instance, a Sanitary Sewer Structure may have a label defined by an Attribute having Default Value, "MH—CO—SS". Note that this does not work if the "Constant" flag is set for the attribute.

Upon insertion, you are given a dialog prompting you to **Define Attribute Values** by selecting from the available options:

The Layer of the Linework entities will be defined to the Standards database; however, because the Color and Linetype of the Linework entities were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Linework Item will follow the Color and Linetype settings of that layer in the new drawing.

To manage Linetype Scale using the **LTSCALE** command, the Scale value of "1" must be set to "Fixed" during the **Insert Item** or **Modify Item** commands.

Using the Offset option, you have the ability to draw multiple Linework Items parallel to one another. Annotation elements may be defined using **DTEXT** or **MTEXT** commands but will always be placed as **MTEXT** entities in the drawing.

When being defined, Text or MText entities should be drawn at 1:1 (plotted text height).

The Text Style, Height and Justification of the Text or MText entities will be defined to the Standards database.

The Layer of the Text or MText entities will be defined to the Standards database; however, because the Color and Linetype of the Annotation were defined as "ByLayer", when placed into a new drawing on the defined layer, the new Annotation Item will follow the Color and Linetype settings of that layer in the new drawing.

Annotation elements may be defined with Leaders or without.

Text/MText entities and their associated Leaders are considered ONE Annotation entity when defining to the standards database.
Make sure to use the **QLEADER** command to ensure Annotation and Leader associativity.

The Dim Style of the **QLEADER** entity will be defined to the Standards database.

Standard Annotation components can be defined having a "Fixed" Height or the Height can be scaled according to the "Horizontal Scale" of the drawing.

If Annotation components are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Text and Leader components.

**Exit Drawing Standards**

The **Exit Drawing Standards** command closes the **Standards Draw** palette and the Standards Database file (.sdb).

This command can be accessed from the **Draw** menu and the **Draw Item** toolbar as shown below.

**Pulldown Menu Location(s):** Draw > Draw To Standard

**Keyboard Command:** exititem

**Prerequisite:** Active Standards Database file (.sdb)

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the **Pline** command. Likewise if you pick text, this command will begin the **Text** command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** pick an entity

The remaining prompts depend on the type of the selected entity.

**Pulldown Menu Location:** Draw

**Keyboard Command:** drawbyex

**Prerequisite:** Entities

**Sequential Numbers**

This command draws a text label and then increments to the next value for additional labels. The label can optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size.

In the dialog, specify the **Text** label. The text **Prefix** and **Suffix** are optional. The **Text Size Scaler** is the text size in paper units that gets multiplied by the horizontal scale from Drawing Setup to set the text drawing size. The Justification setting controls the text justification mode. When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the **Increment** field. The **Group Label With Symbol** option will make a group of the label text and symbol. When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels.
The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.
Prompts

Select Symbol for Numbers dialog select your symbol
Sequential Numbering Options dialog make your choices
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point to the right of the first point
Pick point at beginning of label: press Enter to end the routine

Pulldown Menu Location: Draw
Keyboard Command: numbers
Prerequisite: None

Arrowhead
This command draws an arrowhead at the end of the selected line or polyline.

Prompts

Enter the arrow size <5.00>: press Enter
Pick a line or pline to add arrow: pick a line or polyline
Pick a line or pline to add arrow (Enter to End): press Enter

Pulldown Menu Location: Draw
Keyboard Command: arrowhd
Prerequisite: None

Curve - Arrow
Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. The arrowhead size is determined by the CAD system variable "DIMASZ". In order to change this size, type DIMASZ at the command prompt. This routine also has a Zorro option which creates a Z leader curve.

Prompts
Create a Zorro (Yes/<No>)? N
Include an arrow (Yes/<No>)? Y
Enter the arrow head size <4.00>: press Enter This defaults to the DIMASZ system variable.
Pick a starting point: pick a point
Pick an ending point: pick a point
Pick an intermediate point (U to Undo): pick a point
Pick an intermediate point (U to Undo): press Enter

Examples of Curve - Arrow

**Pulldown Menu Location:** Draw  
**Keyboard Command:** carrow  
**Prerequisite:** None

**Leader With Text**

This command will draw a straight leader between two points, with an arrow at one end and optional text at the other. The arrow size is determined by the Symbol Plot Size setting, found in the *Drawing Setup* command. On the command line, selecting *O* for Options will provide you with more customizing choices to make.

**Prompts**

**Options/Pick Arrow Location:** pick a point  
**Text location:** pick a point  
**Text:** Leader With Text  
**Text:** press Enter

**Leader With Text**
**Special Leader**

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the *Drawing Setup* command. On the command line, selecting *O* for Options will provide you with more customizing choices to make.

**Prompts**

*Options/Pick Arrow Location:* *pick a point* Pick point where leader arrow will start.
*Text location:* *pick a point*
*Text:* *Monument*
*Text:* *press Enter*

**Callout Leader**

This command draws a triangle shaped leader and a label inside a box. There is a dialog to enter the label string, style, size and colors. The leader is drawn in the current layer.
Prompts

Callout Leader Settings dialog
Pick callout point: pick a point for point of leader
Pick textbox corner: pick a point for position of label

Pull-down Menu Location: Draw > Leader
Keyboard Command: callout_lrd
Prerequisite: None

Bold Curve Leader
This command draws a thick curved leader with an arrowhead. This leader is created by picking three points.

Prompts

Starting point: pick a point
End of arrowhead: pick a point
Pick end point of leader: pick a point
Pull-down Menu Location: Draw > Leader
Keyboard Command: site_leader
Prerequisite: None

Flow Leader
This command draws a wavy leader line with an arrowhead. The size of the arrowhead is set by the symbol size scaler in Drawing Setup.
Prompts

Starting point: pick a point for arrow end of leader
Ending point: pick a point for tail end of leader

Pulldown Menu Location: Draw > Leader
Keyboard Command: flowline
Prerequisite: None

Boundary Polyline

This is a streamlined analog of the AutoCAD command Boundary. The Carlson version is faster and works in many cases where Boundary fails. Boundary Polyline supports a snap tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. Then click inside openings you would like to trace and the routine will generate corresponding closed polylines. The duplicate polylines are detected and not created, so that clicking more than once in the same area does not change anything. These new polylines are always created in the current layer. Layers of the original linework do not matter.

Prompts

Select polylines: pick an entities to be used
Enter snap tolerance or press Enter for none:
Pick an internal point: pick the points to enclose

These three polylines are created from original linework by clicking at shown locations

Pulldown Menu Location: Draw
Keyboard Command: boundpl
**Shrink-Wrap Entities**

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points.

**Prompts**

Shrink-wrap across gaps or bounded linework only [Gap/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [2D/3D]? 2D
**Centroid Point**

This command draws points at the centroids of the selected polylines. In the section option, the areas need to be closed polylines representing the blocks to calculate the centroids of. This is useful for calculating haul distances and blast distances in section view. When choosing to come from a grid file, it finds the x,y position for the center of mass. Typically this grid would be the difference between existing and design surfaces, represented as a thickness grid. For example, this routine could be used to find the center of mass for a stockpile using a difference grid of the stockpile grid and base grid.

![Centroids in Section View](image)

**Prompts**

Centroid from cross-section or grid file [Section/|Grid]? S
Select closed polyline(s).
Select objects: 1 found
Select objects:
Center at 146284.64,1971935.94

**Polyline by Slope Ratio**

This command allows you to draw or revise a polyline by specifying distance and slope ratio, percent of grade or pick points on the screen. The polyline could represent a section or profile which can be processed with the Polylines End Area or Sections from Polyline.

**Prompts**

Horizontal scale <50.0>: 20
Vertical scale <50.0>: 10
Pick point/<Starting elevation of polyline-section <100.0>>: P Enter the starting elevation or press Enter to use the default value in brackets and you are prompted for the starting offset or X coordinate. By entering P you are prompted to pick a starting point for the polyline/section.
Pick start point: pick a point
Slope ratio + for up slope - for down slope.
Undo/End-switch to Left/Pick point/<Enter Right Distance>: 130
End/Percent slope/<Slope Ratio (?1) <2.0>>: 5 This enters a slope ratio of 5 to 1 for 130 feet to the right of the starting point.
Undo/End-switch to Left/Pick point/<Enter Right Distance>: L
Undo/End/Pick Point/<Enter Left Distance>: 110
End/Percent slope/<Slope Ratio (?1) <2.0>>: P
Percent of grade slope: 2 This enters a slope of 2 in 100 for a distance of 110 feet to the left of the starting point.
Undo/End/Pick Point/<Enter Left Distance>: 30
End/Percent slope/<Slope Ratio (?1) <2.0>>: 4
Undo/End/Pick Point/<Enter Left Distance>: E Entering E ends the command.

Pulldown Menu Location: Draw
Keyboard Command: PSR
Prerequisite: None

Polyline by Nearest Found
This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

Prompts
Create 2D polyline at zero elevation or 3D polyline [<2d>/3d]? press Enter
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points

SmarTrace
SmarTrace is an enhanced sketch routine. AutoCAD’s Sketch command is acceptable for some tracing, but if a large contour map is sketched, it creates a huge file that loads and regenerates slowly. The problem is that the sketch command creates points at user specified increments, this small increment may be appropriate for sharp corners, however, in relatively straight stretches this is very inefficient.
SmartTrace solves this problem. The routine works by reducing the number of vertices created on polyline tracing by using a deflection angle and minimum and maximum distance. In sharp turns, it will create points at the minimum distance specified, and in relatively straight stretches it creates points at the maximum distance specified. If the angle of the polyline turns more than the specified deflection angle, SmartTrace also creates a point.

**Prompts**

**Deflection Angle** <4.0>: press Enter A range of 3 to 5 degrees is best.  
**Minimum Distance** <5.0>: press Enter Usually 5% of map scale, or 1/20 inch.  
**Maximum Distance** <50.0>: press Enter Usually 50% of map scale, or 1/2 inch.  

**Start point**: pick beginning point on polyline

**Begin Tracing ... Press Pick Button to End.** Carefully move along polyline. press the pick button to complete the polyline

**Pulldown Menu Location**: Draw  
**Keyboard Command**: TABLET3  
**Prerequisite**: None

## Inquiry Menu

Shown here is the Carlson Inquiry menu. The top section contains detailed inquiry commands. The lower section of the menu includes report and file editing commands.

![Inquiry Menu](image)

### Point ID

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

**Prompts**

Pick point or point number: 255

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing (Y)</th>
<th>Easting (X)</th>
<th>Elev (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>4379.83</td>
<td>4265.48</td>
<td>19.01</td>
<td>GROUND/SHOT</td>
</tr>
</tbody>
</table>

*Chapter 2. General Commands* 207
Layer ID

This command reports the layer name of the selected entity.

Prompts

Pick entity to read layer: *pick an entity*
Layer: FINAL
Pick entity to read layer: *press Enter to end*

Layer Report

This command generates a report containing all the layers defined in the drawing. Along with the layer names, the report includes the number of entities on each layer, and the color, linetype and lineweight for each layer.

Layer Report
Drawing: C:\sample\example1

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Entity Count</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREA_PERIM</td>
<td>0</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREATXT</td>
<td>0</td>
<td>Magenta</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>BL</td>
<td>8</td>
<td>White</td>
<td>DASHED</td>
<td></td>
</tr>
<tr>
<td>BL-LAB</td>
<td>76</td>
<td>Red</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
</tbody>
</table>

Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you'd like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only
available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

**Pulldown Menu Location:** Inquiry  
**Keyboard Command:** layer.inspect  
**Prerequisite:** None

**Drawing Inspector**

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.

In the *Drawing Inspector* menu, you can choose one or more properties to display.

**Display Layer Name:** Allows you to display the layer name of the entity.  
**Display Entity Type:** Allows you to display the type of the entity (ie. TEXT or POLYLINE).  
**Display Elevation:** Allows you to display the elevation of the entity.  
**Display Azimuth-Distance:** Allows you to display the azimuth and distance of a line.  
**Display Bearing-Distance:** Allows you to display the bearing and distance of a line.  
**Display Point Data:** Allows you to display the coordinate data of point.  
**Display Text Data:** Allows you to display the attributes of text.  
**Display Curve Data:** Allows you to display the radius, arc length, chord length and delta angle of a curve.  
**Display Polyline Data:** Allows you to display the end point elevations, horizontal distance, slope distance and slope ratios.  
**Display 3D Face Data:** Allows you to display the Z elevations at the face corners.
Display Polyline Blips: Allows you to display temporary blip plus marks at the vertex locations of polylines.
Display Polyline Direction: Allows you to display temporary arrows to show the direction of polylines.

In the Drawing Inspector menu, you can also choose how the property information is reported.

Enable Highlighting: Allows you to highlight the object that the Drawing Inspector is reporting.
Enable Tag Display: Enables you to view the information next to the cursor on the screen.
Show Data On Status Bar: Enables you to view the information on the status bar, in the lower corner of the screen.
Use Default Cursor: When enabled, only the drawing cursor shows. When disabled, the mouse pointer is also shown.
Report In High Precision: When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

Example of Drawing Inspector reporting Bearing-Distance using the Tag Display

Pulldown Menu Location: Inquiry
Keyboard Command: inspector
Prerequisite: None

Bearing & 3D Distance
This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

Prompts
Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0"
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Pulldown Menu Location: Inquiry
Keyboard Command: 3DIST
Prerequisite: None

Find Point
This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is
Prompts

Find by point [N]umber or [D]escription <N>: press Enter
Point number or range of point numbers to find <1>: 8-10
8 4856.75 4747.20 0.00
9 4909.25 4648.37 0.00
10 4223.30 4545.46 0.00 RADPT

If you respond with D for the first prompt the program prompts:
Conforms to AutoCAD's wild card matching.
Point Description(s) text to search for <*>: rad*
Searching file C:\Carlson\DATA/LOT.CRD for point descriptions matching RAD* ...
7 4817.02 4662.73 0.00 RADPT
10 4223.30 4545.46 0.00 RADPT
Point(s) found 2

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None

Calculator

The Carlson Calculator command uses a convenient pop-up calculator with three tabs for a standard calculator, scientific calculator and conversion calculator. The standard calculator does basic math calculations using expressions such as +, -, / and *. The scientific calculator has angle and other functions. The conversion calculator has feet-metric and angle conversions including radians. The standard and scientific calculators support RPN. Here is how RPN works:

1+2 = 3
- type value 1 + Enter
- type value 2 + Enter
- type +
X = 3.

Standard Calculator
Most basic calculations can be performed using this tab in the calculator. Memory functions are also available.
Scientific Calculator
Values can be entered on the X register. The values can be rolled up and down with the up and down arrow keys and the Roll and RollD buttons on the dialog. The Enter key finishes the entry of a number and pushes the stack. The C on the touch screen clears an entry. Additional functions on the screen can be obtained through touching the scroll [<] and [>] area of the screen.

Conversion Calculator
This mode provides for conversion between many units. Enter a value in any field and press Enter to find the conversion value. The following units are available in Feet, Meters and International Feet, Degrees, Minutes, Seconds and Gons/Grads and Decimal Degrees.
Pulldown Menu Location: Inquiry
Keyboard Command: cscalc
Prerequisite: None

Curve Info
This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts
Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]? Y
Polyl ine Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: *pick a polyline or line*
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Polyl ine Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: *pick a polyline or line*
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Polyl ine Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: *pick a polyline or line*
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Prerequisite: None
Keyboard Command: cinfo

Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: *pick a polyline or line*
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None

Angle Info

This command reports the interior and exterior angles defined by two joining line segments or by three points. The coordinates, angles and distances of the line segments are also reported. The report is display in the standard report viewer.

<table>
<thead>
<tr>
<th>Angle Information</th>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Point:</td>
<td>11</td>
<td>4728.73</td>
<td>5660.09</td>
</tr>
<tr>
<td>Corner Point:</td>
<td>12</td>
<td>4684.89</td>
<td>5624.99</td>
</tr>
<tr>
<td>End Point:</td>
<td>13</td>
<td>4664.02</td>
<td>5690.60</td>
</tr>
<tr>
<td>Bearing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Side:</td>
<td>S 38°40'56&quot; W</td>
<td>56.16</td>
<td></td>
</tr>
<tr>
<td>Second Side:</td>
<td>S 72°21'16&quot; E</td>
<td>68.85</td>
<td></td>
</tr>
</tbody>
</table>
Prompts

Define angle by, Points/<select line or polyline>: P for points
1st Point?
Pick point or point number: 11
2nd (Corner) Point?
Pick point or point number: 12
3rd Point?
Pick point or point number: 13
Interior: 68°57'18'' Exterior: 291°02'42''
Angle Info Report Viewer
1st Point (Enter to end)?
Pick point or point number: press Enter

Pulldown Menu Location: Inquiry
Keyboard Command: ainfo
Prerequisite: None

Display-Edit File

This command allows you to edit or review an ASCII/text file. Files are displayed in the Standard Report Viewer section of this manual.

Pulldown Menu Location: Inquiry
Keyboard Command: scedit
Prerequisite: A file to edit

Display Last Report

This brings up the last report generated by any Carlson command that uses the standard report viewer.

Pulldown Menu Location: Inquiry
Keyboard Command: report_up
Prerequisite: A previously viewed report

Load Saved Report

This brings up the Report Formatter for the report data file saved previously by the Report Formatter.
Settings Menu

Shown here is the Carlson Settings menu. The top section contains the commands most important for setting up the drawing. You should run Drawing Setup prior to starting work in your drawing. Additional setup and settings features are found in the middle section. The last section of the menu includes AutoCAD/IntelliCAD settings commands, including the System Variable Editor.

Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.
• Specify **English 1\text{in}=?\text{ft}** or **Metric 1\text{m}=?\text{m}** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.

• Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1\text{"} = 50\text{'} is your drawing scale.

• The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.

• The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.

• The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.

• **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD **UNITS** command.)

• **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD **UNITS** command.

• **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates.
and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the section on Localization under the Coordinate File Utilities command for more information. The Project Scale Factor is multiplied by the x,y coordinates when converting between drawing and geodetic coordinates.

• **Projection:** There are several built-in projection including State Plane 83, State Plane 27 and UTM. Also on the Projection list is an item for More Pre-Defined as well as User-Defined projections. This expanded Pre-Defined selection includes the projections used in SurvCE which has hundreds of projections including the US County projections for Minnesota and Wisconsin as well as from around the world. When you pick Pre-Defined, a dialog shows a list of recently selected Pre-Defined projections.

You can pick from this recently used list, or pick the Add Pre-Defined to select from the built-in list.

The Add From File button reads in a projection saved to a file by this routine or by SurvCE CSL or ESRI PRJ. The Edit button allows you to change the name or parameters of a projection. The Remove function removes a projection from the list of recently used projections. The Add User-Defined routine defines a projection by setting the ellipsoid, choosing the method and entering the parameters. There are over 25 built-in ellipsoids to choose from such as Clarke 1880. You can also manually enter the ellipsoid values. The projection definition includes the 7 parameter Helmert transformation to go from WGS-84 to the user datum. There are over 20 projection types to choose from such as Transverse Mercator. After selecting the projection type, there are edit fields for each of the parameters for the selected projection. The Test button brings up a calculator to enter a lat/lon and report the projection coordinates as
Besides Drawing Setup, these projection functions are also used in the Coordinate Transformation function in Coordinate File Utilities.

• **Project Name and Job Number** are optional fields that are used in the header for reports.

• **Report Distance Scale Factor** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be entered directly into the edit box or calculated using the Set button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor.

• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.
– The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.

– The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.

### Prompts (for Set Paper)

**Pick or Type lower left corner point for border** *(5000.00 5000.00 0.0) -> pick a point*

**Erase existing Set Paper boundary** *(<Yes>/No) -> Y*  This prompt only appears if there is an existing paper boundary in this drawing.

**Set Limits** *(Yes/<No>) -> Y*  If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

**Pulldown Menu Location:** Settings  
**Keyboard Command:** setup  
**Prerequisite:** None

## Set Project/Data Folders

This command sets the project work folder, the data folder and the settings folder to use as the default folders for your Carlson drawing and data files. The PROJECT folder is the top-level folder for all the data sub-folders with all the files for the project. The DATA folder contains project specific data files such as coordinate (.CRD), profile (.PRO) and centerline (.CL) files. The SETTINGS folder contains program settings files that can apply to multiple projects such as Field-To-Finish Code Tables (.FLD) and Draw Profile Settings (.PFS). These folders are the defaults where the file selection dialogs will start in. When selecting files, you can change to another folder at any time.
Data Folder Setup: This grouping of controls provides varying levels of sophistication towards how data files associated with a given project are stored and organized on your computer system. Three options are provided:

- **Project Folder** - Data files are organized and stored (by default) into a user-definable sub-folder structure and this option is often used by larger organizations that have teams of employees working on a project. Selecting this option enables the Project Sub-Folders Setup and Data Type Sub-Folders buttons.

- **Drawing Folder** - Data files are stored (by default) into the same folder where the current project drawing has been directed and this option is often used by mid-sized or smaller organizations who seek only basic data organization.

- **Fixed Folder** - Data files are stored (by default) into a single folder and might be used by smaller organizations who do not require any type of data organization.

Project Sub-Folders Setup: Click this button to create a folder structure (see the sample below) that is created when a new project is created. The list of project folders can be customized at any time but modifications to the folder structure will only occur on projects that are created after the modification(s) to the Project Folder list.
Data Type Sub-Folders: Clicking this button allows the various types of data files produced by Carlson to be assigned to a folder identified with the Project Sub-Folders Setup command as illustrated below. File types that are not assigned to a sub-folder are stored (by default) in the current project folder. The following controls allow you to organize your data file types:

Control  Action

\*  Creates a new data type sub-category.
\*  Removes the selected data type sub-category. Any data types that have been assigned to the sub-category are subsequently migrated into the Misc Data-Types category.
\*  Allows the selected data type sub-category to be renamed.

Category Controls

Move To: Associates the selected data type(s) with a data type sub-category. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

Assign Folder: Assigns the selected data type(s) to a project sub-folder. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

Load: Loads a previously saved Data Type Sub-Folder (.DSF) file.
**Save As:** Saves the current Data Type Sub-folder configuration to a Data Type Sub-Folder (.DSF) file.

**Report:** Allows the contents of the current Data Type Sub-folder configuration to be sent to a report.

**Edit Sub-Folders:** Initiates the Project Sub-Folders Setup command.

**Startup Project/Data Folder:** Indicate or use Set button to assign the start-up (or default) Project Folder location (when using the Project Folder option) or the start-up Data Folder location when using either the Drawing Folder or Fixed Folder option.

**Current Project Folder:** This setting is the top-level project folder for the current drawing.

**Current Data Folder:** This setting is the default data folder for the current drawing.

**Reassign Data Folder:** This function shows a list of all the folders used for data files associated with the current drawing. You can select a folder from this list and switch to another folder location which re-associates the data files. This function applies to projects that have been moved in the file system.

**Clear Data Folder History:** This function removes the association of all data files with the current drawing. The effect is to go back to defaults for data file selections.

**Use Data Folder For Settings:** When enabled, this option sets the Settings folder to match the Data folder which, in effect, combines the Settings and Data folders into one folder.

**Startup Settings Folder:** This folder is the default Settings folder for new drawings.

**Current Settings Folder:** This folder is the Settings folder for the current drawing.

**Project File:** Indicate or use Set button to specify the Project Settings (.PRJ) file associated with the current drawing. The Project Settings file is a collection of drawing names (e.g. BaseMap.dwg, Roads.dwg, Parcels.dwg, Sewers.dwg, etc) that belong to the same project. This collection of drawings is used by Project Explorer to manage the drawings and data files for the current project and must be specified if the Carlson Data Depot service is to be used. If the current drawing is not associated with a project, then this setting will be blank.

**Data Depot Type:** The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and merge the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Carlson Software supports the following version control systems:

1. Subversion - a free, open-source version control system.
2. ProjectWise - software developed and produced by Bentley Systems.

**Setup:** Before proceeding, refer to the Carlson Data Depot section for information on how to install and properly prepare your preferred document management system. Once this has been completed, click this button to complete the Data Depot Settings.
Server Location (Subversion): Indicate the path for the appropriate location (often a shared server drive) where the file edits and updates are tracked (e.g. file:///C:/svnrepo). For Windows users, note the triple-slash convention. For a more extensive write-up on available options, refer to Subversion in Action - Chapter 1. Fundamental Concepts.

Server Location (ProjectWise): Indicate the ProjectWise server and datasource where the file edits and updates are tracked (format is server-name followed by a colon ':', followed by the datasource name, e.g. esri:pwtest). See your ProjectWise Administrator for the name of your ProjectWise servers and datasources.

Automatic Check-Out on Startup: This option will check for any updates for the project and associated file on the server while opening the drawing. If there is a new version of a file is found it is automatically updated to match the current version on the server. User will be prompted if an older version or conflicting versions of file are found.

Use Automatic Project Folder Name: When a project is updated or initially accessed with the get_prj_from Depot command, this option will automatically map the project to a folder with the same name as the repository project name under your Startup Project Folder. For example, if your Startup Project Folder is named "C:\Carlson Projects\" and the repository project is named "My Test Project" the get_prj_from Depot will use ""C:\Carlson Projects\My Test Project\" as the local Current Project Folder.

Include User Name in Project Folder Name: When "User Automatic Project Folder Name" is enabled this option will also be enabled. When a project is updated or initially accessed with the get_prj_from Depot command, this option will automatically map the project to a folder with the same name as the repository project name, plus your user name under your Startup Project folder. For example, if your Startup Project Folder is named "C:\Carlson Projects\", your user name is "Betsy" and the repository project is named "My Test Project" the get_prj_from Depot will use ""C:\Carlson Projects\Betsy\My Test Project\" as the local Current Project Folder.

Set Read-Only File Attribute for Drawings Not Locked by the Current User: This option will prevent the user from being able to save drawings for which he/she is not the lock owner. This prevents the user from getting into situations that may cause potential loss of data at check-in time.

Automatic Check-In Changes: If any file under project is updated or edited, it will be automatically checked-in to the repository.

Automatic Upgrade Read-Only to Edit: If a file is checked-in by the current user, the file is upgraded to Edit Mode (locked) for that user for further editing opportunity.

Revert to Read-Only After Upgrade from Edit: If a file is checked-in by the current user, the file is reverted to Read-only Mode (unlocked) so that other users can further edit the file.
Once the Data Depot has been configured, you can assign a project to the Data Depot via the Project Explorer command.

**Pulldown Menu Location(s):** Settings  
**Keyboard Command:** settmpdir  
**Prerequisite:** None

### Store Project Archive

This command will zip and archive an entire project. The archive contains the current drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. Besides project data files, images and xref's attached to the dwg are also included. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. The current dwg must have a name before running this command.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** zip_project  
**Prerequisite:** A named dwg

### Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** unzip_project  
**Prerequisite:** A project file that has been zipped (ZIP)

### Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. `Configure` will restore the current drawing settings to
these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.

The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in Configure, and will be described here.

**General Settings:**

**Use Startup Wizard:** The *Use Startup Wizard* controls whether this wizard appears when creating a new drawing.

**Generate Report Log:** When the *Generate Report Log* option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on/off, you can type REPORT at the command prompt. This function toggles the report log on/off.

**Save Drawing INI Files:** Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.
Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth which is the default. South Azimuth uses a value of zero for due south and a value of 180 for due north.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the command DVIEW. This is similar to Twist Screen.

Set DIMSCALE to Drawing Scale: This will set the dimension scale system variable to match the drawing scale from the Drawing Setup command.

Set AUNITS to Drawing Angle Mode: This will set the angle units system variable to match the angle mode from the Drawing Setup command.

Set PDSIZE to Symbol Size: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup.

Set INSUNITS to Unitless: This will set the INSUNITS (Insertion Units) system variable to Unitless when the drawing is opened.

Set LTSCALE on startup to Drawing Setup: This will set the linetype scale system variable to the value from the Drawings Setup command when the drawing is opened.

Coordinate Report Order: You can choose the traditional north-east format, or reverse these in reports with east-north.

Date Format: You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

Report Viewer: This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

Formatted Document Type: This setting controls whether to use PDF or DWF documents for formatted reports such as Calculate Total Volumes in Takeoff and the 3D Viewer Window print function.

AutoCAD Menu: This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

Object Linking: The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

Database Format: The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.

CRD File Pt# Format: Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:
Carlson Numeric: This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 99999.

Carlson Alphanumeric: This native Carlson format allows letters in the point numbers, and the point name can be up to 9 characters. Any combination of letters and numbers is acceptable.

Carlson SQLite (.CRDB): The Carlson coordinate database (.CRDB) is based on SQLite and supports point numbers and descriptions up to 255 characters.

C&G Numeric: This format of the C&G division supports up to 5 digits, with a 65000 point limit.

C&G Alphanumeric: This format of the C&G division supports up to 10 characters, with no limit to the number of points.

Simplicity ZAK: This is the Simplicity Systems coordinate file format.

MS Access Database (LDT): This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is typically found in a Land Desktop project \COGO subdirectory. The point identifier limitation is established by the database structure, which has a default of 255 characters.

Digitizer Puck Layout & View: There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

Use Mouse: This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

Auto Tablet On for Digitize Commands: This option will activate the auto tablet when using the digitize commands.

Remove Arcs: Since 3D polylines do not allow true arcs, the program draws arcs in 3D polylines as a series of short chords. The Remove Arcs settings control the spacing of these arcs. The Max Offset method sets the maximum difference between the chords and the original arcs as shown in the graphic here. This method is similar to the Reduce Polyline Vertices command. The Chord Len method sets the length of the chord segments that replace the original arc.

Drawing Setup:
The settings under Drawing Setup are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the Configure menu choice, using the Localization Settings button.

**Survey Settings:**

**CG Survey Menu** controls whether to add-on the C&G Survey pulldown menus to the standard Carlson Survey menus. The Compact mode has all the C&G commands in a single pulldown menu. The Expanded mode has all eight C&G pulldown menus that C&G standalone used to have.

**Initial Traverse/Sideshot Angle Mode** sets the default angle mode for these COGO commands.

**Show Occupy and Backsight Points on Status Bar** is an option for the COGO Inverse command.
**Automatic Raw File On** is equivalent to toggling on the COGO->Raw File On/Off automatically when the drawing is opened.

**Automatic Line On** is equivalent to toggling on the COGO->Line On/Off automatically when the drawing is opened.

**Automatic Point Object Snap On** is equivalent to toggling on the Settings->Point Object Snap On/Off automatically when the drawing is opened.

**Survey Settings**

- **CG Survey Menu**: Compact
- **Initial Traverse/Skidshot Angle Mode**
  - Azimuth
  - Angle Right
  - Prompt
- **Show Occupied and Backsight Points on Status Bar**
- **Automatic Raw File On**
- **Automatic Line On**
- **Automatic Point Object Snap On**
- **LDT Fieldbook Codes**

**Surface Settings**

- **Inverse Distance/LeastSquares Modeling Parameters**
  - **Search Radius**: 10,000.0
  - **Max Samples**: 20
  - **Min Quadrant**: 0
  - **Max Quadrant**: 20
- **Specify Grid Resolution As**
  - **Number of Cells in X and Y**
  - **Dimensions of Cell**
  - **Grid Precision**: 0.0000
- **Draw Contours**: Max Number of Rechecks for Crossings: 10

**Surface Settings:**

Most of the Surface commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

**Inverse Distance/LeastSquares Modeling Parameters**: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**Specify Grid Resolution As**: There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision**: This is the number of decimals that are stored in the grid file.
**Draw Contours Max Number of Rechecks for Crossings:** Routines that generate contours check for any crossings that can occur from smoothing or reduction options. When a crossing is found, the smoothing or reduction factors are reduced and then the contours are rechecked in case that adjustment causes a new crossing. This option can be used to decrease the number of rechecks in case your dataset is large and you don't want to take the time for these checks.

**Section-Profile Settings:**
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image)

**Hydrology Settings:**
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image)

**Mine Note Options:**
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry. The Spad and Offset symbol sizes are set here for drawing in CAD. The layers for pillars and the Perim for underground mine design are set here. They can be customized so the program will recognize specific layers for commands such as volumes by grid or average, and calculating the extraction ratios.
Mining Settings:
This is the configuration screen for default settings used with the Geology and Mining Modules. Each item is detailed below.

Inverse Distance/Least Squares/Triangulation Search Radius, Samples and Quadrants:
The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined, while triangulation just uses the search distance to find the next data point to triangulate to. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance): This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing
strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. NONE will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. ALL will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are defined. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. NONE will let each seam do what they want, independent of any other seam. ALL has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The marker bed is the "main" seam and other seams will conform to it. There can be more than one marker seam. There is also a hierarchy for conformance, so if the main marker seam is not present, then the next marker seam in line will prevail.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinched out when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best estimate is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turned on when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Pinchout Zero Thickness:** This setting will recognize a zero thickness entry in a drillhole and treat it as a pinchout for modeling. Normally, the zero entry is treated as a zero value, and the seam would go to zero just at the hole, and not before. Treating a zero value in a drillhole as a pinchout, will treat it as if it wasn't in the drillhole, and the seam will be pinched out using the pinchout slide bar settings above, instead of just going to zero right at the hole.

**Pinchout Key Only:** This setting will apply the pinchout settings to just the Key seams in the drillholes. The NonKey seams will model as if the pinchout setting is off.

**Restrict Pinchout to Drillhole Elevation Range:** This setting provides the option to control where the seam will pinchout. If there is a shallow hole, and a seam is running beneath it, this setting will pinchout the seam if it is off. If it is on, then the seams will only pinchout if they pass through the elevation range of the drillhole. This is useful if it is desired to pinch out a seam that passes above or below the elevation range of the drillholes.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weigh the quality attribute by a Density value instead of thickness. The Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.
Use Strata Limit Lines: When using Strata Limit Polylines for modeling, this needs to be turned on for the program to use them, even if they are on screen. If just using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one setting is on, then you will be prompted to select them for all commands.

Auto Select All Strata Limit Lines: Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

Process Only Strata with Beds: This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

Process Only Strata with Definition: This option will process and model only the strata and beds that are defined with the Define Strata command that creates the *.SDF file. If the seam is not on this list, then it will be ignored for processing and modeling.

StrataCalc Drillhole Selection Method: This setting defines how the program will prompt for modeling the geology. If it is set to On-Screen Drillholes, then that will be what the program is looking for when modeling. If this setting is set to StrataCalc File, then the program will prompt for the presaved StrataCalc file with the extension of *.STC. This file is created in the Geology Module, under the StrataCalc menu.

Underground Room/Pillar Settings: The following settings are used for the series of commands for placing coal sections to calculating end of month volumes.

Use 0 Values for Blank Entries in Coal Sections: When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

Draw Coal Sections Z at Thickness: This option will draw the coal sections symbol at the Z value of the actual thickness. So if the coal section has a thickness of 5 feet. When it draws it in the drawing, it will have a Z value of 5. This is useful for contouring or gridding the coal sections with standard Civil commands.

Prompt for Advancement Pline for Quantities: When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

Report Format for Quantities by Avg/Grid Methods: This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

Key Material Name: This is the name of the KEY material you are mining. For example, enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

Bed Name Suffixes: KEY, TOP, PARTING & BOTTOM: These settings allow for custom naming of the Bed Name extensions the program adds to the bed names when it does the processing and modeling. The default settings are KEY, TOP, PARTING & BOTTOM. These can be customized, such as replacing _TOP with _OB.

SDPS Directory: This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

Use Map Object Data as Properties: This setting will use the AutoCAD Map data as the information stored for the Property and Owner when using those named polylines in the drawing. If this is not set, then the program will use the standard Owner and Property names assigned as normal.
**Startup Settings:**
These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

![Startup Options](image)

**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.

**Profile Name:** This is the AutoCAD/IntelliCAD Profile that will be used when working in Carlson.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the startup procedure.

**AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**No menu resetting:** This controls whether to set the Carlson menu as the main customization file on startup or to keep the current main customization unchanged.

**Takeoff/SiteNet Options:**
These options are used for the Takeoff module and SiteNet commands in the Civil module.
**Automatic Update Colors:** This refreshes colors in your drawing as they change: i.e. elevating entities, setting layers for different Targets, etc. If your drawing is very large and is slow to automatically refresh you may want to toggle this off and use the **Update Colors For Set Elevations** command under View when you want/need to see the color changes.

**Assign Colors By Target:** This option allows you to set the Existing, Design, and Other layers to any color you define.

**Assign Colors By Elevation:** This option allows you to set the color for entities needing elevations.

**Extrapolate Surface To Boundary Perimeter:** When this is check ON surfaces are extended and volumes are calculated out to your boundary perimeter. When this is checked OFF surfaces and calculations end at the extents of your design data.

**Use Existing Surface To Extrapolate Design:** When this is checked ON surfaces and volumes are calculated to the extents of your existing data.

**Use Binary Triangulation File Format:** This option sets the format for the surface model files as either binary or ASCII. The binary format has a .tin file name extension and loads about twice as fast and has about 50% less file size than ASCII. The ASCII format has a .flt extension and is the legacy format used by other Carlson products and Softdesk.

**Minimize Flat Triangles:** This option reduces the occurrence of "flat" (or more precisely, horizontal) triangles. Flat triangles often occur when creating surface models from contour data. The Minimize Flat Triangle option will swap triangulation edges when possible to switch flat triangles to sloped triangles.

**Reduce Triangulation Surfaces:** This causes edges within the selected surface Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.
**Reduction Offset Distance:** This setting is used by the Reduce Triangulation Surfaces command to set the reduction tolerance. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Surface File Suffixes:** These settings allow you to change the file names for the surfaces generated by the program.
- *-og:* This is the default name for the original ground surface before adjustments.
- *-ze:* This is the default name for the original ground surface after subgrade zone adjustments.
- *-ex:* This is the default name for the original ground surface after subgrade zone and topsoil adjustments.
- *-bs:* This is the default name for the initial design surface before adjustments.
- *-zn:* This is the default name for the design surface after subgrade zone adjustments.
- *-fn:* This is the default name for the design surface after subgrade zone and topsoil adjustments.

**Localization Options:**
There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

![Localization Settings](image)

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.

**Pulldown Menu Location:** Settings
**Keyboard Command:** config_scad
**Prerequisite:** None
Data Depot

The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and merge the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Also, having a central project repository helps with data back-up eliminating the fear of losing data due to local drive failures. The Carlson Data Depot protects against productivity loss due to re-implemented work, not only avoiding losses of data, but also making each user's work readily available to other users on the project. The general process for implementing your preferred document management system is:

1. Install and initialize one or more of the version control software products listed below.
2. Instruct Carlson Software to utilize one of these services by establishing the needed settings in the Set Project/Data Folder command.
3. Assign a project to the Data Depot through the use of the Project Explorer command.
4. Subsequently open or update any Data Depot project through the use of the Get Project from Data Depot command.

Carlson Software supports the following version control systems:

- Subversion - a free, open-source version control system.
- ProjectWise - software developed and produced by Bentley Systems.

Subversion is a powerful revision control system which is actively evolving and is part of Apache web-server project

The home page of this project is http://subversion.apache.org/, with a book on setup, use and administration available in print and online at http://svnbook.red-bean.com/.

Carlson Software supports Subversion release 1.5.6 or newer.

While there multiple ways to setup Subversion repository and connect to it, the most typical scenario is setting up Subversion server and connecting to it through the web-server. Local directory setup is also available, but not useful in group environments. Running the shared directory on the network should not be attempted since it could lead to the repository corruption and permanent data loss.

Setting up a Subversion server on Windows host

For users who run Windows on their host there is a nicely integrated front-end to a standard Subversion server (included): VisualSVN server (http://visualsvn.com/server/). There are two licenses available for commercial users: free basic edition and reasonably priced enterprise edition with additional features larger sites will find attractive. This document will concentrate on install of the basic edition.

Download and run the VisualSVN install.
Select option to install VisualSVN server

Specify repository directory where the data will be stored. This should be secure and backed up location since this is where the data will be stored. The server port and https:// setting are standard and most users will want to leave them untouched. The authentication setting is a matter of the site preference. Enterprise edition of VisualSVN offers additional authentication options like using Microsoft Active Directory server.

Upon completion of the install the manager interface will be displayed. Create a new repository by right-clicking on the Repositories:
Give new repository a name. You may choose to have several repositories, each containing data of the similar kind or covering an area of your business. Do not toggle on "Create default structure" since these folders will be created under a particular project.

Create users and set passwords (if using Subversion's own user authentication)

Run "Manage security" command by right-clicking over whole repository to set defaults or right-clicking on specific folder to set specific permissions:
Add users or user-groups and set specific permissions for the folder you selected:

This completes the server side installation of Subversion.

**Setting up a Subversion server on Linux host**

Subversion is a project which was born on Unix platform, so it is fairly straightforward to setup and run on the Linux host. Specific details may vary for different distributions, but below is a quick summary of steps for Redhat or CentOS based hosts, which should at least point you in the right
direction.

Install needed packages

The following packages should be installed:

httpd - Apache web server for access to the subversion
subversion - the Subversion command line and administration tools
mod_ssl - support for secure connections
mod_dav_svn - integration between the Apache and Subversion

Create repository folder

Run the following command to configure the Subversion file structure:
svnadmin create –fs-type fsfs /var/lib/subversion/repos
where 'fsfs' refers to the type of the file storage being selected and last argument is the future location of the repository data files on the system.

Configure Apache to be handle Subversion calls

Apache configuration file httpd.conf is typically located in /etc/httpd/conf folder. Please modify it to contain a section like this:

```
<Location /repos>
DAV svn
SVNPparentPath /var/lib/subversion/repos
AuthType Digest
AuthName "Subversion"
AuthDigestdomain /repos/
AuthUserFile /var/lib/subversion/svn_passwd
Require valid-user
SSLRequireSSL
</Location>
```

Restart Apache server. This should let you reach your Subversion server with URL like this: https://server_name/repos.

User control

The configuration above assumes the authentication for the domain "Subversion" handled by Apache itself. Much more powerful options are available, but since these are standard Apache features, plenty of documentation for is readily available.

To add new users, please use the following command:

```
htdigest -c /var/lib/subversion/svn_passwd "Subversion" user_name
```
where -c is for "create" and only should be used first time. Supply user name for whom the password is being set.

The permissions are controlled by the svnserv.conf typically located in /etc/subversion directory. The equivalent configuration to the Windows example above would look like this:

```
[Projects/]
Carlson.Readonly=r
```
Creating a local Subversion Repository

The Windows MSI installer with the basic win32 client binaries can be downloaded at:
http://www.collab.net/downloads/subversion/

Running this installation file installs the required binaries to create the Subversion repository on the server or local machine under "C:\Program Files\Subversion" using the default options.

To create the Subversion repository:

1. Click the Windows Start > Run and then type cmd into the resulting dialog box as shown below and click OK:

2. At the DOS prompt, navigate to the Subversion install directory by typing:
   cd "C:\Program Files\Subversion" and press the Enter button to complete this step as shown above.

3. To create the Subversion repository under the "C" drive, type:
   svnadmin create c:\svnrepo and press the Enter button to complete this step as shown above. This will create a "svnrepo" folder under the "C" drive (c:\svnrepo); see the Notes section below for important information.
   The path and the name of the repository could be path to a network drive as well. For setting up a Subversion Repository on the server, refer to the http://subversion.tigris.org documentation.

4. Type the word exit and press the Enter button to dismiss the DOS window and complete the command as shown above.

Note: Once you have created a Subversion Repository, do not add, delete, or modify files in the Repository folder unless you know how to avoid corrupting the repository

Setting Subversion URL in Carlson

In order to connect Carlson to Subversion repository, please go to Settings, Configure Carlson, Project/Data Folders settings. Set the project type to Subversion and click Setup button. Specify server location like file:///c:/svnrepo for local example above, or https://server_name/repos for network server as described above. Other URL types supported by Subversion for the scenarios beyond the scope of this document are permitted as well.

Accessing Subversion through a GUI Client
There are various graphical-user interface (GUI) client applications available for accessing the SVN repositories on the Internet for free:

- RapidSVN
- SmartSVN
- TortoiseSVN
- ViewVC
- WebSVN

Once a supported document management system has been properly installed and configured for each computer work-station, continue with the Data Depot configuration by initiating the Set Project/Data Folder command.

Please see your ProjectWise Administrator for instructions on configuring ProjectWise Datasources.

Pulldown Menu Location(s): None

Keyboard Command: None
Prerequisite: None

Carlson Settings Explorer

The Carlson Settings Explorer dialog box allows you to view, manage and report the values for all settings in all commands in all Carlson Software programs.

The left-side of the dialog is a tree-view showing "Carlson Software" as the top item in the tree. Then, each Carlson Program or module is included as a sub-item under "Carlson Software". The Menus are then displayed as sub-items under each Carlson Program. And then the Commands in each Menu are listed as sub-items of the Menu.

The right-side is a spreadsheet view and is populated depending on the item(s) selected and highlighted in

Chapter 2. General Commands 244
the tree-view. Selecting and placing a checkmark next to an item at one of the upper levels of the tree structure will select that item and all its sub-items.

The spreadsheet view shows the following columns for a command:

- **Setting** - Prompt for the settings in the dialog or at Command: line
- **Value** - Current value
- **Default** - Default value for the setting
- **Ini Name** - Carlson internal file name for the command
- **Data Type** - Description of the value for this setting

**Select/Unselect:** If you pick and highlight an item in the tree-view that is un-checked, this button displays "Select". If the selected item is already checked, this button displays "Un-Select". After an item is selected and highlighted, picking the "Select" or "Unselect" button will place or remove the checkmark next to that item and all its sub-items.

**Select All:** Use this button to place a checkmark next to all items and sub-items in the tree-view.

**Clear All:** Use this button to clear checkmarks from all items and sub-items in the tree-view.

**Show Selected Only:** Select this option to display - in spreadsheet view - only those settings that have checkmarks next to them in the tree-view.

**Filter:** Using a Filter will display only those settings containing the text string specified as the Filter. for instance, Filtering with the word "elevation", returns the following results:
Find: Use this option to search for a string of text. First, enter the text to be found and then pick the button to the right to execute the search.

Show Modified Only: Select this option to display only those settings whose current value, as shown in the "Value" column, is different from the default value shown in the "Default" column.

Show Layers Only: Select this option to display only those settings whose value in the "Data Type" column is specified as "Layer".

Report: Use this button to prepare a report of all selected settings using Carlson's Report Formatter.

Load: Use this button to Load settings from a Carlson Configuration File (.cfg).

Save: Use this button to Save settings to a Carlson Configuration File (.cfg).

Restore: Use this button to Restore selected settings to their Default value.

Pulldown Menu Location: Settings

Keyboard Command: setxplore

Prerequisite: None

### Settings File Manager

The Settings File Manager provides an organized view of all Carlson Software Settings files that have been saved in a specified "Settings" folder. By default, the initial folder displayed is the "Startup Settings Folder" as specified in the Project Setup dialog box.

The various Settings files are displayed in a tree structure based on their corresponding Carlson Software program. If the current Settings for any command match the Settings found in a Settings file, the file name will show up in a Bold font. Because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold font.
**Set Current**: After selecting one of the various Settings files, use this button to set that file current. Files that have been set "Current" will show up in a **Bold** font. Only one file of any Setting type can be set Current at one time. And, because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold.

**Change Settings Folder**: Use this button to browse to and select a folder in which Carlson Software settings have been stored.

**Pulldown Menu Location(s)**: Settings

**Keyboard Command**: setmanager

**Prerequisite**: None

---

**Edit Symbol Library**

This command allows you to customize the symbol library. For a printout of the default symbols, get the symbols.pdf in the Carlson Projects folder.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.

The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also
Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

**Pulldown Menu Location:** Settings
**Keyboard Command:** editptsym
**Prerequisite:** None

**Layer Library**

This feature serves as an expanded version of the Layer Manager and also as a layer standards manager. In addition to allowing the user to sort layers into easily recognizable groups called **Layer Categories**, this feature can also be used to import layers from a text file and to compare and match layers in the library to the current drawing.

Once populated, layers from the Library can be called from commands such as **2D Polyline** and **3D Polyline** for layer and property assignment. Also, the **Item Standards Manager** is able to export layers from the items database to the **Layer Library**.

The **Layer Library** has two areas of the dialog box: the **Layer Category** List on the left and the **Layer** List on the right.
Layer Categories: Layer Categories are shown as a list in a tree view in the left-hand pane of the dialog box.

Categories can be re-ordered by dragging and dropping to a different position in the list or by using the Move Up, Move Down, Move Left and Move Right arrow buttons. Other buttons above the Layer Category list also enable the user to Add, Remove and Rename Categories.

Also, right-clicking on a Category in the list displays a shortcut menu allowing the user to access many of the same commands as the buttons along the top and bottom of the dialog box.

Layers: Layers in a selected Category are shown as a list in spreadsheet view in the right-hand pane of the dialog box.

The default column-headings for the Layer List are Name, Description, Color, Line Type, Line Weight, Plot Style and Plot/No Plot. Additional column-headings may be added using the Extra Fields button at the bottom of the dialog. Using the Add Layer (plus) and Delete Layer (minus) buttons, layers can be easily added and removed from a particular Category. The Move To button can also be used to change a layer to a different Category.

Clear All: This button removes all the Layer Category and Layer definitions.

Save As and Load: These buttons can be used to create and restore Layer Library settings using a Layer Library Settings (.LA) file. The current layer library definitions are stored in the USER folder in a file named layerstd.dta.

Extra Fields: This button allows the user to define up to ten extra text fields (column headings) for a layer. These fields can then be used as import fields or displayed in a report.

Report: This button uses the Report Formatter to allow the user to compile and display a report containing all Layer Categories and Layers in the Library. The Report Formatter can also be used to export the data to a Microsoft Excel (.XLS or .XLSX) file.

Import: This button gives the user two options for Importing layers into the Layer Library.

The Drawing Layers option simply copies all layer
definitions from the current drawing into the Library after prompting the user to select the destination Category.

The Text File option allows the user to select an existing Text (.TXT, .DAT, or .CSV) file containing standard layer definitions to populate the Library. Note that Microsoft Excel provides an option to save an Excel (.XLS or .XLSX) file as a Text file. Follow the steps below to Import layers from a text file.

1. Pick the Import button.
2. Pick the Text File (txt;dat;csv) button. This opens the Text File Import Options dialog box.

![Text File Import Options dialog box]

3. At the top of the Import Options box, select the file format type such as "Comma-Separated" or "Tab Separated".
4. If the top-line of the Text file contains column headings, pick the option to "Use first row for column headers".
5. If the Text file contains one or more lines of text above the layer and property data, use the text box next to "Skip" to specify the number of rows at the top of the text file to be "Skipped" before importing the list of layers.
6. If headers are not included in the Text file, use the drop-down at the top of each column heading in the spreadsheet view to specify the column's data type such as "Name", "Color" or "Linetype".
7. Pick the Continue button and specify the Category into which the new layers are to be Imported.

**Create**: After selecting a Layer Category, the user can pick this button to create all the layers for that Category in the Drawing.

**Compare DWG**: This button is used to Compare drawing layers and their associated properties such as color, linetype, linewidth and plot style to the standard Library definition for those layers. This feature will report how many layers matched exactly, how many had a different set of properties and how many non-Standard layers were found. It will also list the non-standard layers which are those defined in the drawing but not in the Library.

**Match DWG**: This button is used to alter the properties of drawing layers to match the properties of layers defined in the library, or vice versa. After picking the Match DWG button, this dialog box displays:
Pick the **Library to DWG** button to alter the drawing layers to conform to the Library definitions.

Pick the **DWG to Library** button to alter the Library definitions of the layers to conform to those set in the drawing.

**Pull-down Menu Location:** Settings → Layer Library  
**Keyboard Command:** layerlib  
**Prerequisite:** None

---

**Quick Keys**

Quick Keys can provide an enormous time savings on initiating keyboard commands. One frustration of using CAD is when your command initialization cannot keep up with your train of thought, and you are constantly seeking the fastest way to initiate commands. Quick Keys provides numerous command aliases that are already set up for you, which you can customize easily. You can also add any new commands quickly and easily using the Quick Keys editor, without leaving CAD. The Quick Keys are so productive, that even dedicated menu users appreciate and use them.

The Quick Keys Editor can be broken down into areas. The spread box at the top of the screen, spread control buttons, and program control buttons. Each area and button is explained below.

**Spread Box** contains a list of the loaded quick keys. Use the scroll bar to move up and down through the list or maximize the dialog to view more rows. Each item can be edited in its cell.

Each record item consists of up to a 5 character quick key (the portion typed in at the command line), and a long command or AutoLISP expression. Note that if you are adding a shortcut to a lisp function, you must use the following syntax: (C:FUNC) where FUNC is the command name. All Carlson commands use this lisp function syntax. To find the lisp function name for a Carlson command, you can run the command from the menus and look for the command name in Command window. Also, you can find the command name in the Keyboard Command field at the end of each command description in the manual. For example, enter (c:quickkey) for the command to run Quick Keys. For CAD commands, the command name can be entered directly with a prefix of "'". For example, the CAD Area command name should be entered as 'AREA. Some CAD commands will run in command line prompt mode instead of dialog mode when issued by the command name from Quick Keys. For these commands that you want to run with the dialog, enter the command with this syntax of (c:acad_command "name"). For example, enter (c:acad_command '_plot") for the CAD Plot command in dialog mode. There are several examples of this included with the Quick Keys defaults.

If you intend to make changes in an item, use standard editing procedures, including the use of arrow keys along with the tab key and/or pointer movements to make changes. Pressing enter on either field will have no effect on the item in the list.
Changes made to items are automatically changed in the list, you must use the **OK** button to record changes to be saved.

When a new item has been created in the edit fields, you must click the **Add** or **Insert** button to add the item to the list and type in your key, command and description in respective columns.

Highlight the item you wish to delete in the list box, then press the **Delete** button to remove it from the list. In the event you accidentally delete items, simply choose **Cancel** to exit without saving changes.

At any time during processing of Quick Keys, you may choose the **Sort** button to sort the list of Quick Keys or left click on respective column header to sort it using key, command or description. The most common use of sort will be after adding several new items to the list.

The buttons on the bottom row are used to control files. Changes made to the Quick Keys table are stored when exiting the dialog with the **OK** button. The original key definition file supplied is called Carlson.QKS. However, when you make changes for the first time and use the **OK** button to exit the dialog, the program writes changes to a file called CUSTOM.QKS. The Quick Keys editor looks for the existence of the file CUSTOM.QKS when loading, and will use this file when available. This approach will shelter your (CUSTOM.QKS) from overwrites if you reinstall Carlson.

When all changes are complete, choose the **OK** button to save changes, which will automatically build and load the run time file. Any Quick Keys added or updated will be immediately available at the command prompt. However, if a key definition was deleted, it will not be removed from memory until another drawing is loaded or you begin a new drawing.

The **Cancel** button exits the Quick Keys dialog without making any changes to your system.

This **Report** option is used to obtain a printed list of the Quick Keys currently loaded. First consider sorting the list, then use this option and enter a filename. The program will write the list to a file that can be brought into any editor or word processor, then printed.

The **Save As** button can be used to save the current quick keys as a QKS file that can be distributed to other computers and can be loaded using **Load** button.

**Pulldown Menu Location:** Settings
**Title Block**

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The "other" choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
**Pulldown Menu Location:** Settings

**Keyboard Command:** tblock

**Prerequisite:** Set horizontal scale in Drawing Setup
Mortgage Block

This command draws a personalized title block for a mortgage survey. You may select an 8½" x 11" sheet, an 8½" x 14" sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the mortgage.dwg file located in the \sup directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 ½ x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a mortgage.ini file located in the \User directory.

The LIMITS of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Edit menu.

Pulldown Menu Location: Settings
Keyboard Command: mortgage
Prerequisite: Set horizontal scale in Drawing Setup

Rescale Drawing

This command resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.

Prompts

Old Horizontal Scale: 20
New Horizontal Scale: 30
Select text, symbols, dimensions and blocks to scale.
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter
Pulldown Menu Location: Settings
Keyboard Command: scaledwg
Prerequisite: Drawing entities to be scaled

Set/Reset X-Hairs

*Set X-Hairs* sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. *Reset X-Hairs* restores the crosshairs alignment to horizontal.

Pulldown Menu Location: Settings > Crosshairs
Keyboard Commands: setxhairs, resetxhairs
Prerequisite: Line entity

Save/Load Tablet Calibration

A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

Save Configuration Procedure:
1) Command: TABSAVE
2) Designate filename (*.TCF) to save configuration into.

Restore Configuration Procedure:
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

Pulldown Menu Location: Settings > Tablet Calibration
Keyboard Commands: tablet1, tablet2
Prerequisite: None
Create AutoCAD Icon

This command will create an icon on your desktop to launch plain AutoCAD.

Many people assume that the stock AutoCAD icon will launch plain AutoCAD. This is not always true. The problem occurs because, if no profile is specified, AutoCAD always starts with the last used profile. If you run Carlson, then exit and then execute the stock AutoCAD icon (which does not specify a profile), Carlson loads anyway.

When you run this command, an AutoCAD profile called Vanilla is created, and an AutoCAD icon is created on the desktop that specifies this startup profile.

*Technical Note:* In its attempt to create the vanilla profile, this routine removes references to Carlson from the support file search path, and replaces the Carlson menu with the stock AutoCAD menu. If the program cannot locate the AutoCAD menu (due to it being deleted or moved), you may have to create the icon manually, as outlined in the Carlson Software Knowledge Base on-line.

**Pulldown Menu Location:** Settings

Point Object Snap

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD *NODE* snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the 2DP command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.

**Pulldown Menu Location:** Settings  
**Keyboard Command:** 'pointsnap  
**Prerequisite:** None

System Variable Editor

The AutoCAD/IntelliCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.
• **List Box**: Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

• **Edit Field**: When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

• **Description**: When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

• **Integer**: Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.

• **Real**: Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.

• **String**: Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.

• **2D Point**: Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.

• **3D Point**: Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must used, separating the X and Y and Z values.

Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.
• **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.

• **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.

• **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

• **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.

• **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

• **Off (0)**: Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.

• **On (1)**: Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.

Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each buttons purpose is explained below.

• **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

• **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.

• **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

• **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

• **Print**: Used to print the current system variables. After choosing this option, you will prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each buttons purpose is explained below.

• **Change**: Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.

• **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.

• **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of supported system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.
Points Menu

All of the routines in this menu operate on points in a Carlson coordinate (.CRD) file. Coordinate files are binary files that contain point numbers, northings, eastings, elevations and descriptions. The Carlson coordinate database (.CRDB) is based on SQLite and supports point numbers and descriptions up to 255 characters. Alternately, C&G CRD and CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. All routines in this menu will read from, and write to, these types of point data files. At any given time, there can only be one active coordinate file. If a command is initiated that requires a coordinate file while one is not set, Carlson will prompt for a coordinate file name. From that point on, this is the current coordinate file. Another coordinate file can be used by choosing Set Coordinate File or Open CRD File in Coordinate File Utilities.

Whenever you asked for point numbers, you can enter any combination with commas and dashes or type ALL to use all points. For example 1-3,7,20-23 would act on points 1,2,3,7,20,21,22,23. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point# 7A). The type of point number format is set when the coordinate file is created. This setting is found under General Settings in Carlson Configure. This setting only affects new coordinate files.

Each point is drawn by three entities:

1. point block
2. point node
3. symbol

The point block is an INSERT entity with PNTNO, PNTELEV and PNTDESC attributes. These attributes represent the point number, elevation and description respectively. The point node is a POINT entity and is used for picking the point with the NODE snap. The point node is also used as the X, Y, Z coordinate in Triangulate & Contour. The symbol can be any symbol defined in the Symbol Library (use SPT0 for no symbol). Since points use Carlson point symbols, the CAD system variables PDMODE and PDSIZE should usually be set to 0.
The points in the drawing can be linked to their coordinates in the coordinate file. The link updates the coordinate file when a point is modified in the drawing. For example, when points are moved with the Rotate Points command, their coordinates will be automatically updated in the coordinate file. To update the coordinate file without this automatic link, you can run the command Update CRD File from Drawing in Coordinate File Utilities. The linking option is called Link Points with Coordinate File (currently only available in AutoCAD) and can be set under General Settings in Carlson Configure. This setting does not affect points currently in your drawing, only points drawn after you change this setting.

Each point in the coordinate file has room for a 32 character description. To have a longer description, an associated point note file can be used. The note file has the same file name as the coordinate file with a .NOT extension and is stored in the same directory as the coordinate file. For example, survey.not would be the note file for survey.crd. The note file is a text file that stores a point number together with the additional notes for the point. There is no limit to the length of the note. Notes can be added to points using the Edit Points command. The List Points command can be used to print out the notes.

For each point, the point attribute block, node, and symbol can be bound together into a "grouped" entity. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality.

To disable this system altogether, navigate to Carlson Configure > General Settings and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A (holding down the 'Ctrl' key and then pressing the letter 'A' on the keyboard activates this two way toggle and the current status will be echoed to the Command prompt area).

Carlson points include additional information on each element that makes up the point collection (attribute block, node and symbol). This information allows Carlson to know such things as which coordinate (.CRD) the point came from. Commands like Drawing Inspector can then display the point information for the point entities. This also makes it easier for Carlson to identify which drawing objects belong to a point, making commands like Edit Point Attributes a "double-click" pick association instead of a selection set.

**Point Defaults**

This command sets Carlson point options.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Elevations:** Specify whether you are prompted for a point elevations when creating points and whether the point elevations are labeled in the point block.

**Locate on Real Z Axis:** When checked, points are located at their actual elevation, otherwise points will be located zero elevation.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Symbol Name:** Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the symbol library.

**Prompt for Symbol Names:** When checked, you will be prompted for each symbol name instead of using the default symbol.

**Point Numbers:** When this toggle is OFF, no point number will be created and no points will be stored in the coordinate (.CRD) file.

**Automatic Point Numbers:** When this toggle is OFF, commands that locate a point will prompt for a point number. Otherwise, point numbers are numbered sequentially. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the Draw-Locate Points command and use the Range option, then a
The following table illustrates the effects of elevation settings:

**Elevations Yes**
- **Real Z No**
  - Picked Point: Labels point, Prompts for elevation, uses 0 for z coordinate
  - Point Number: Labels point, No Prompt, uses 0 for z coordinate

**Elevations Yes**
- **Real Z Yes**
  - Picked Point: Labels point, Prompts for elevation for z coordinate
  - Point Number: Labels point, No Prompt, uses z coordinate from file

**Elevations No**
- **Real Z No**
  - Picked Point: No Label, No Prompt, uses 0 for z coordinate
  - Point Number: No Label, No Prompt, uses 0 for z coordinate

**Elevations No**
- **Real Z Yes**
  - Picked Point: Labels point, No Prompt, uses z coordinate of picked point
  - Point Number: Labels point, No Prompt, uses z coordinate from file

**Start Point Number:** Specify the next point number to use.

**Vertical Angle Mode:** Specify how Carlson should prompt you for vertical angles. None means no prompt. Applies to creating points with commands such as *Traverse*. The vertical angle is used to calculate the point elevation.
Separate Layers: Specify settings for point attribute layers.

None: The point symbol, point number, elevation and description use the layer names PNTMARK, PNTNO, PNTELEV and PNTDESC.

Points: The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC.

Symbols: The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.

Both: The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

Layer for Points: Specify the layer name for Carlson points.

Auto Zoom: When checked, the drawing will perform a Zoom—Center around new points to keep the display centered around current working area. This only applies during commands such as Traverse. This setting is also available in Configure under General Settings where it is called Auto Zoom Center for New Points.

Use Field to Finish For: Allows you to use the code definitions from Field to Finish for the Point Symbols, Layers, Descriptions, Attribute Layout IDs and whether to locate the point on the "Real Z" and whether to Separate Attribute Layers when creating new points. For example, when creating a point with description "EP", Carlson would look up "EP" in the Field to Finish table and will use the field code definitions to establish the point instead of the definitions defined in Point Defaults.

GIS File: This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results to the note file (.not) associated with the current CRD file.

Pull down Menu Location: Points
Keyboard Command: ptsetup
Prerequisite: None

Draw-Locate Points
The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.
The name of the symbol file is displayed in **Symbol Name**. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

**Symbol Rotation Azimuth** is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

**Layer by Desc** inserts the points in the layer named by the point description. Using Layer by Desc organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.

**Draw Nodes Only** inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting **Elev Text Only** draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

**Locate within Polyline** inserts only the points that are inside a closed inclusion polyline. The command prompts you to select a closed inclusion polyline and as well as an optional exclusion polyline. All the points in the current coordinate file are checked. Any points that are located within the inclusion polyline and outside the exclusion polyline are drawn.

**Locate within Distance** inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

**Locate within Window/Coord Range** inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

---

**Chapter 2. General Commands**
Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted.

**Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

- Use ‘+’ labels the positive elevations with a leading ‘+’. For example, ”+159.43”.
- Use ‘-’ labels the negative elevations with a leading ‘-’.

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered.

**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name, CLAYER, or choose an existing layer by clicking **Select Layer**. Entry of CLAYER selects the current layer. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for
all the points.

The **Erase Duplicates** option will erase existing point entities that match the point numbers currently being drawn.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting. When a grid projection is defined in Drawing Setup, then there is an option to enter the points using latitude/longitude.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** choose **Screen Pick**

**Pick point to create:** pick a point

**Select/<Enter Point Elevation <0.00>:** Enter elevation Press S to select text to set elevation.

**Enter Point Description <>:** Enter

N: 5106.57 E: 4901.96 Z: 0.00

**Enter/<Select text of elevation>:** Select text entity that defines elevation of point.

To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose **Draw Range**

**Point numbers to draw:** 3

**Points Drawn > 1**

Locates point 3.

**Point numbers to draw:** 1-2

**Points Drawn > 2**

Locates a range of points. From 1 to 2.

**Point numbers to draw:** Enter

**Keyboard Command:** lpoint

**Prerequisite:** A CRD file and you may want to execute **Drawing Setup** (see the Setting menu) to set the scale and size.

**List Points**

This command generates a report of point numbers, northing, eastings, elevations and descriptions.
Selection Method-Range allows you to specify the points to list by point number range.

Selection Method-Area allows you to select a closed polyline to list all of the points inside of that polyline.

Selection Method-Selection Set allows you to specify the points to list by selecting them from the drawing.

**Range of Points:** If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the All button.

**Point Group** allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.

**Description Match:** Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.
**Report Coordinate Range:** When checked, the point list will include the minimum and maximum northing, easting and elevation.

**List Point Notes:** When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the Input-Edit Point command found in Coordinate File Utilities.

**Use Report Formatter:** When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

**Double Space Between Points:** When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the Edit Points command in the Points menu.

Example of List Points Report:

```
List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description> 0.000 Job Date> 06/01/2002
Point No. Northing(Y) Easting(X) Elev(Z) Description
1 5355.240 5000.000 91.8 CP2
2 5000.000 5000.000 90.0 CP2
1000 5355.236 5000.000 91.8 CK
1001 4941.911 4622.029 91.4 FPC
1002 4952.629 4642.818 90.6 FH
1003 4959.931 4634.440 89.8 TOE1
```

**Pulldown Menu Location:** Points

**Keyboard Command:** listpt

**Prerequisite:** Points in a coordinate file or on the screen

**Import Text/ASCII File**

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:

5100.0,5150.5,485.1
5127.1,5190.3,487.3
The Coordinate Order would be:

Y,X,Z

For a text file with point number, easting, northing, elevation, description and space delimiters:

1 5000.0 5000.0 490.3 TRAV
2 5030.4 4930.5 495.5 TRAV
The Coordinate Order would be:

P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can
either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File.

Multiple files can be imported at once. To do this, toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

Under Process Options, there are choices for selecting the coordinate file to store the imported points. The Current option uses the current coordinate file that is active in the drawing. This coordinate file name is shown at the bottom of the dialog. The Prompt For Another option uses the standard file selection dialog to select the file. The Name Another By Input File uses a coordinate file name with the same name as the input file except for a file extension of .CRD.

The special formats of Leica .d45/.gsi/.raw files, TDS .cr5 files, Topobase .ro files, Geodimeter .obs/.raw/.are files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files, CAICE/Caltrans .tss files, NLS MMH360 .360 files, EMXS .xng files, and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.
Pulldown Menu Location: Points  
Keyboard Command: readpt  
Prerequisite: A text file to read

Export Text/ASCII File

This command outputs point data from the current Carlson coordinate file to an ASCII text file formatted according to a variety of options presented in the form of a general dialog.

**Format.** Specify the type of file to write from the drop down list. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, D45, Cadavantage, Multiplane and SDMS CTL formats. In addition there is a User-Defined Format option to define the order of the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data:
Selection. There are three Selection Methods provided for the data to export. Notes associated with the points may be included in the export by enabling the check box. Specify either Range, Screen Points or Screen Entities in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from:

Delimiter. Select the desired field delimiter of the export file as either Comma or Space from the drop down list. If a header line is to be included, enable the check box.

Number of Decimal Places. Select the desired number of digits to be included in the mantissa of all output ordinates.

Location Filter. Choose from filter methods of within inclusion perimeter polyline, by coordinate window or center within radius from a center point.

Wild Card Descriptions Match. A description filter is also available for exporting only points from the range or selection set with certain descriptions.

Export Multiple Crd Files. Enable this check box to specify multiple CRD files to apply the selection criteria against. If enabled, an additional dialog will be presented from which you can browse, select, and remove as many CRD files as desired.

Point Group. Displays the Point Group manager dialog from which you may define, modify, and select one or more Point Groups to define the points to be included in the export.
After selecting the OK button, a final dialog appears that allows you to specify a new file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

**Pulldown Menu Location:** Points
**Keyboard Command:** writept
**Prerequisite:** A Coordinate File (.CRD)

### Set Coordinate File

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the *Configure* command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.

![Set Coordinate File Dialog](image)

**Pulldown Menu Location:** Points
**Keyword Command:** setcrd
**Prerequisite:** None

### CooRDinate File Utilities

This command allows you to manipulate the coordinates stored in a coordinate (.CRD) file. One of the most important commands is the Update CRD File from Drawing which allows you to update the file after editing the drawing with commands such as *Erase*, *Move*, *Rotate* or *Change Elevations*. Another handy option is the *Draw Entities by Point Number* which allows the user to input point number ranges and plot Lines, Arcs, Polylines or 3D polylines.
Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point number 7A). The type of point number format is displayed at the top title bar of the main dialog. Another coordinate format is the Carlson coordinate database (.CRDB) which is based on SQLite and supports point numbers and descriptions up to 255 characters.

In addition to running the routines through the dialog, many routines have command names that you can enter at the Command: prompt, create a Quick Key, or put into a toolbar. Here are these command names and their corresponding dialog button names:

setcrd: Open CRD File
listpt: List Points
delpnt: Delete Points
readpt: Import Text/ASCII File
writept: Export Text/ASCII File
scalept: Scale Points
transpt: Translate Points
rotatept: Rotate Points
alignpt: Align Points
cfuelev: Elevation for Points
cfureport: Point Number Report
cfuduplicate: Duplicate Points
cfucmpare: Compare Points
cfuhistory: Point History
cfucopy: Copy/Merge CRD File
cfuupdatedwg: Update Drawing from CRD File
cfuupdatecrd: Update CRD File from Drawing
cfu: Description for Points
cfu: Coordinate Transformation

Open CRD File: Allows the user to switch to another file. When you exit Coordinate File Utilities this will be the
current file that you work with in Carlson.

**Copy/Merge CRD File:** This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

![Copy/Merge Coordinate File](image)

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.

![Range of Points to Export](image)

Next there’s a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together, for example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don’t have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.
Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.

**Convert CRD File Format:** This allows you to convert the current CRD file from numeric format to alphanumeric format or vice versa. This routine will also change crd files to and from different software formats. These formats include Carlson SQLite (.CRDB), C&G, Microsoft Access (.MDB) in same format as AutoDesk Land Desktop, and Simplicity (.ZAK). The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

**Map Points from 2nd File:** This routine adds point to the current CRD file from points stored in a second CRD file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to
create in current crd file) and source point number (point number to be copied from second crd file) will be displayed.

**Import Text/ASCII File:** This routine converts point data from a text file into the current coordinate (.CRD) file. See the *Import Text/ASCII File* command in this chapter for more information.

**Export Text/ASCII Text File:** This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See the *Export Text/ASCII File* command in this chapter for more information.

**Edit Header:** Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.

**Coordinate Transformation:** Transforms coordinates between local, state plane 27, state plane 83, latitude/longitude, and Universal Transverse Mercator (UTM). Works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between state plane 27 and 83, Carlson calls upon NADCON from the National Geodetic Survey to apply the latitude/longitude adjustment. The NADCON program, ndcon210.exe, is stored in the Carlson EXEC directory.

The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.
Example Lat/Long to Grid dialog

For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the Screen Entities. If a range of points or a particular point is desired, the Point Numbers option would be used. Manual entry of coordinates to transform one at a time is accomplished with the Enter Coordinates option. The coordinates can be typed in or use the Input Point Number option. Output Point Number is an option to store the results in the coordinate file.

For all transformations there are two output options when using point numbers as the input data. Overwrite Existing Coords replaces the original coordinate values with the new coordinate values after transformation. New Point Numbers will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a Local Coordinate System, there are two options for defining the transformation as shown in the next dialog.

The Align by Two Pairs of Points option uses two pairs of source and destination coordinates. The first pair defines
the translation as the difference between the source and destination northing and easting.

This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.

---

**Over Determination by Plane Similarity** is used to find the least squares best fit transformation for all the
given source and destination points. Besides doing a translation and rotation, this option will also scales the points during the transformation. The **Rigid Body Transformation** also does a best fit least squares transformation, but applies only translation and rotation with no scale. The **Helmert 7-Parameter** method can also be used for local transformations. The **7-Parameter Values** can be calculated from control points or entered by the user.

The **Add** button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

![Add Alignment Point dialog box]

The **Edit** button is used to edit existing data.

The **Delete** button removes the source and destination pairing from the transformation setup.

The **Process On/Off** button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The **Optimize** option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The **Report** option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The **Load** and **Save** options allow for saving and recalling local coordinate transformation pairings and settings.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.

**Prompts**

**Plot Entities by Point Number**

Type of entity, Arc/Polyline/3dpoly/2dline/Exit/<Line>: P This response causes the program to plot polylines. Example: ‘1*4-7-10*12-5-8’ would draw lines from point number’s 1 through 4 then to 7, to 10 through 12, then to 5 to 8. (limit 132 characters)

Undo/<Enter point numbers or ranges>: 1*10-20*30

The program draws a polyline from point number 1 through 10 to point number 20 through 30.

New Last Point Number: This option sets the highest point number in the CRD file. All points above this number are erased.
Swap Northing-East: This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) becomes the northing(s).

Point Entry CRD File Links Manager: When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the coordinate file such as Move Point which selects a point entity and updates the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the coordinate file assigned to point entities which is useful when the coordinate file has been moved after the points were drawn. Use the Unlink button to remove the link.

Update Drawing from CRD File: This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.
Update CRD File from Drawing: This function allows you to select all or some of the points in the drawing and add or update them to the .CRD file. The points can be filtered with AutoCAD’s Select Objects: selection mechanism and/or wild card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the CRD file. Use this command to update the file after a global edit such as Move, Rotate, Renumber Points, Change Elevations, Erase, etc. This routine directly reads Leica (Wildsoft), Softdesk, Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

List Points: List the points stored in the .CRD file. See the List Points command in this chapter for more information.

Delete Points: Deletes points in the coordinate (crd) file by point number or description.

Screen Pick Point: Pick a point on the graphics screen and it's coordinate values are added to the coordinate (crd) file. Prompts for point number, elevation and description will be displayed. This command does not plot a point, point attributes or point symbol. Use the command Draw-Locate Points command to do this.

Scale Points: This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for metric-English conversion. See the Scale Points command in this chapter for more information.

Translate Points: This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See the Translate Points command in this chapter for more information.

Rotate Points: This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See the Rotate Points command in this chapter for more information.

Align Points: This option does a translate based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. See the Align Points command in this chapter for more information.

Description for Points: This routine modifies the point description field with the user-specified text for a range of point numbers. There is an option to update the description attributes of the points in the drawing in addition to updating the coordinate file.
Elevation for Points: This routine modifies the elevation of the specified points. The Absolute method sets the elevations to the specified value. The Differential method adds the value to the current elevations. The Scale method multiplies the current elevations by the value.

Point Number Report: This routine lists the used and the unused point numbers in the CRD file.

Duplicate Points: This function searches the CRD file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be erased or only reported. For the erase option, the first point number is kept and any higher point numbers with duplicate coordinates are erased from the CRD file.
Compare Points: This function compares the coordinates in the .CRD file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another CRD file or with different point numbers from the same CRD file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report.

Example Bearing-Distance format Compare Points Report

Renumber Points: This option renumerates points in the user-specified range starting from a new point number. The old point numbers are erased. The condense points will renumber such that there are no unused point numbers in the renumbered range. Otherwise the spaces between the points is maintained. In the example shown, renumbering 1-25 with points 1,2,24,25 to starting point number 101 will result in points 101,102,103,104 if condense is on or
101,102,124,125 if condense is off.

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. The standard description field is limited to 32 characters. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press Enter. To edit a note, highlight the line in the list box and edit the text in the edit box.

**Point History:** All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back. It is important to note that if maintaining such a history file is your objective, in the Settings > Configure > General Settings dialog you must make sure that Maintain CRD History File is checked.
The Disable History Feature button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying Enable History Feature. You can also choose Delete History File to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting History, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on Details also shows the selected command's details. Undo thru Selected will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

Point Protect Toggle: This option, located at the bottom-left of the main Coordinate File Utilities dialog, toggles point protection on and off. With this option on, when attempting to store a point with a point identifier (point number) that already exists in the current coordinate file, the following dialog will be displayed.

Overwrite with new coordinates will update the existing point number with the new location of the point.

The Use Another Number field displays the point number that will be used if the Use Another Number option
is selected. This number will depend upon the option chosen from the **Another Number From** settings. If **Next Available** is chosen, the next available number will be displayed in the **Use Another Number Field**. If there are number gaps in the coordinate file this number will not be the next highest number in the file. For example if points 1-10 and 20-30 exist in the crd file leaving a gap from 11-19, the Next Available number would be 11. If the desired point number, in this example, is 31, then the option of **End of File** would be selected.

The **Overwrite All** and **Renumber All** options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing CRD files.

**Pulldown Menu Location:** Points  
**Keyboard Command:** cfu  
**Prerequisite:** None

---

**Point Group Manager**

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

---

**Groups Pulldown**

**Create Point Group:**  
This routine creates point groups. When selected, the New Point Group dialog box is displayed.
**Group Name** is the name of Point Group to create.

**Description** is the description of Point Group to create.

Use the **Include Tab** to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When **Include All** is toggled on, all points in the coordinate file will be included in the selection.

When **Point List** is toggled on, an option of defining the point list must be selected.

**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools, are available for selection of the points.

**DWG: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
CRD: Add Within Circle allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

CRD: Add Within Polyline allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

Elevation Range allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

Set By Selection allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

Set From List allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.

The Description option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.

The Exclude Tab allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12, an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

Save Changes saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

Cancel Changes discards specified rules and changes and goes back to the Point Group Manager dialog.

Edit Point Group:
This function allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.
See Create Point Groups for further definitions of the available options.

**Delete Point Group:**
This deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Copy Point Group:**
This routine creates a new point group by copying the currently highlighted group. This allows you to modify an existing group definition and create a new group.

**Import Point Groups:**
This allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.

**Points Pulldown**

**Insert into Drawing:**
This routine draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

![Point Group Manager -- Select Groups or Individual Points](image)

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.

**Erase from Drawing:**
This erases specified point group/groups or specified points from within the group from the drawing.

**Erase from Coordinate File and Drawing:**
This erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:
Selecting **Yes** will complete the command and erase the points from the screen and also the coordinate file. Selecting **No** will cancel the command leaving the drawing and the coordinate file unchanged.

**Report:**
The routine will generate a point list of the points contained in the selected group/groups or specified points from within the group.

**Highlight:**
This routine highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

**Freeze:**
This routine freezes the points like the Points->Freeze Points command.

**Thaw All:**
This routine thaw the points like the Points->Thaw Points command.

**Draw 2D Line:**
This routine draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

**Export:**
This command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When **ASCII/Text** is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.

### Button Functions

The series of buttons at the bottom of the main dialog do the same functions as the routines in the Groups pull-down menu except the Move Up and Move Down which are only available as these buttons. The Move Up/Down simply change the display order of the groups in the list.

**Pull-down Menu Location:** Points  
**Keyboard Command:** pgm  
**Prerequisite:** A coordinate file

### Edit Points

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. Edit Points shows all the points in the coordinate file. New points can be added and points can be deleted by using the Insert and Delete keys.

The Group option allows you to edit subset collection of points as defined by Point Group Manager. This Group method is a way to filter the points by point range, elevation range or description.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension ".not" having the same name as the CRD and residing in the same folder.
Pulldown Menu Location: Points
Keyboard Command: editpt
Prerequisite: None

**Erase Points**
This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the three entities that make up a Carlson point: the point symbol, point attributes, and point node. There is an option to skip erasing the point symbol in case you want to leave the symbols in the drawing. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with *Draw-Locate Points* or *Field-to-Finish*.

**Prompts**

Select points from screen, group or by point number [Screen/Group/\(<\text{Number}\)]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file [Yes/\(<\text{No}\)]? press Enter
Delete point symbols [\(<\text{Yes}\>/\text{No}\)]? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Pulldown Menu Location: Points
Keyboard Command: DELPT
Prerequisite: Carlson points to be erased

**Freeze Points**
This command freezes Carlson points to hide them from view without erasing them. Use the Thaw Points command to show the points again. This command works similar on points as Freeze Layers works on layers. The points to freeze can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.
**Pulldown Menu Location:** Points  
**Keyboard Command:** freezept  
**Prerequisite:** Carlson points to freeze

### Thaw Points

This command thaws Carlson points that were frozen with the Freeze Points command to show the points in the drawing again. This command works similar on points as Thaw Layers works on layers.

**Pulldown Menu Location:** Points  
**Keyboard Command:** thawpt  
**Prerequisite:** Frozen Carlson points

### Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and Z can be entered directly or calculated from original and destination coordinates. The original and destination coordinates can be entered directly, specified by point number, selecting the point number from a point list by selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified, the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points in the drawing will be updated automatically in addition to updating the coordinate file.
Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.

With Process Elevations checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

Ignore Zero Elevations is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With Translate Screen Entities checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.

Various Output Options for the translated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.
**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40...) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command **MOVE** can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in **Configure**. (Note: This toggle must have been turned ON prior to locating the points). If you do use the **MOVE** command and the CRD file needs updating, run the command **Update CRD file From Drawing** found in **Coordinate File Utilities**.

**Pulldown Menu Location:** Points  
**Keyboard Command:** transpt  
**Prerequisite:** points in a coordinate file

---

**Rotate Points**

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

![Rotate Points Dialog](rotate_points.png)
The **Rotation Point** will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the **List** button to pick from a list of points contained in the coordinate file, or from the screen by using the **Pick** button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The **Original Bearings/Azimuths** and **Destination Bearings/Azimuths** can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With **Rotate Screen Entities** checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to rotate (points excluded):.

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation of the points and screen entities will be completed.

Various **Output** options for the rotated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a **Value to add to point numbers** field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

**Description Match** option only rotates points with the description(s) specified in this field.
The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** rotatept  
**Prerequisite:** points in a coordinate file

### Align Points

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked from the point list by selecting the List button.

![Align Points dialog box](image)

When **Align Screen Entities** is checked, after specifying the point range or group to align and selecting OK on the dialog box the following command line prompt is displayed:

**Select objects to rotate (points excluded):** At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When **Ignore Zero Elevations** is checked, all points with an elevation of 0 will be ignored in the alignment.

**Undo Last Align** restores the points to their previous location before alignment. It is important to note that if Align Screen Entities has been checked to restore the aligned objects to their previous location will require the use of the
undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** alignpt  
**Prerequisite:** Points in a coordinate file

---

**Scale Points**

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.

![Scale Points dialog box](image)

Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. This calculation process begins with the Calculate Scale Factor dialog shown below.
The **Projection Type** must be specified as either State Plane 83 or State Plane 27 as well as what state plane **Zone** is required.

The available **Coordinate Units** are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The **Range of Numbers** to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the **List** button.

**Scale Direction** determines which way the scale factor will be calculated. A scale for **Ground to Grid** or **Grid to Ground** can be calculated and applied.

Pressing the **Calculate** button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the **OK** button.

The **Report** option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points  
**Keyboard Command:** scalept  
**Prerequisite:** points in a coordinate file

---

**Move Points**

This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: a POINT entity, a symbol, and a point attribute block with the point number, elevation and description. This routine updates the X,Y of the point and not the Z. To update the elevation, use commands such as Edit Point Attributes or Translate Points. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point. Setting the Link Points with CRD File from Carlson Configure->General Settings is not necessary because the coordinate file is always updated since the Move Points command has built-in smarts to lookup the coordinate file for the selected point entity. The Link Points settings applies to generic CAD commands like the regular Move command.

**Pulldown Menu Location:** Points  
**Keyboard Command:** mpnt  
**Prerequisite:** Carlson points
Edit Point Attributes

This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: Select point to edit (Enter to end). At this point, you can select any part of the point including the symbol, elevation, point number or the description. Next, a dialog will appear as shown.

To change the symbol, either type in a new symbol name in the edit box, or choose the "Select Symbol" button where you can choose from a list of symbols. To change any of the other properties of the point, simply change or replace the contents of the edit box with the new information. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in the coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point(s) changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted [O]verwrite w/new coordinates, [O]verwrite [A]ll, or use number <1000>: . You can choose to use the next available point number in the CRD file (this is the default), or overwrite the point number. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update screen entities. Selecting the History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.

You may also choose to use the AutoCAD DDATTE command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

Pulldown Menu Location: Points
Keyboard Command: ediptnt
Prerequisite: Carlson points
Edit Multiple Pt Attributes

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.

After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attributes properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.
The X location refers to the distance in the X direction from the center (or insertion point) of the point symbol. The Y location refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The Layer refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the Attribute Block Layer option. The Height is expressed in real units (generally feet or meters), not plotted size. The Rotation angle is expressed in absolute decimal degrees. The Color can be set ByLayer or to a specific color. The Point Entity Layer refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required. The Visibility setting allows for attributes to be shown or hidden in the drawing.

To change a point symbol, check on the Symbol tab and use the select button to choose the desired symbol. On the Point Entity tab, the Attribute Layout ID refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

The Sync Layer/Height function sets the layer or height for some or all the attributes. The layer and height can be entered manually or pick an existing attribute to get the value.

Example sequential use of Edit Multiple Points dialog

Again, the number of points selected will be shown in the dialog title. Let's now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.
Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:

![Edit Multiple Points Dialog](image1)

Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:

![Edit Multiple Points Dialog](image2)

At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.
Move Point Attributes Single
This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

Prompts
Select Point Number, Elevation, or Description to Move: select point attribute
Pick new location: pick point
Pick new angle: pick new angle or press Enter

Move Point Attributes with Leader
This command allows the user to move Carlson point attributes (including the point number, elevation or description), and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts.

Prompts
Select Point Label to Move (O for Options, R for Restore): select point attribute
Pick label position: pick point
Select another Point Label to Move (O for Options, R for Restore, Enter to End): O
Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the attribute block’s height, that the leader must be.

Draw Horizontal Leader Tick: Specifies whether or not to draw a terminating tick (a short horizontal line segment sometimes referred to as a "hook line").

Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the attribute block’s height, that the leader must be before an arrowhead is placed on it.

Arrow Size Scaler: A scale factor to apply to resize the arrowhead symbol.

Leader Offset Scaler: A distance indicating the desired offset from the point node to the tip of the leader.

Use Separate Leader Layer: Specifies whether or not to use a layer other than that of the identified point for the leader. Use the Select button to choose an alternative layer for the leader.

Select another Point Label to Move (O for Options, R for Restore, Enter to End): R
Select Point Label to Restore: pick label

Pulldown Menu Location: Points
Keyboard Command: movepntleader
Prerequisite: Carlson points

Scale Point Attributes
This command will scale point attribute text (number, elevation and descriptions) and point symbols up or down in size. The routine prompts for a scale multiplier and a selection set of objects. If you want to enlarge, enter a value greater than one. If you want to reduce, enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. This command has the added benefit that it will adjust the point attributes and symbols to a new screen twist angle.

Prompts

Scaling Multiplier <0.500>: 2.5 This response would enlarge the point attributes and symbols by 250 percent.
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points, pick a point
Select objects: Specify opposite corner: pick a point
Scaling Carlson Software Point Attributes ....
Number of entities changed > 174
Erase Point Attributes
This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

Prompts

Select Point No., Elev, or Desc to Erase: select point attribute

Twist Point Attributes
This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

Prompts

 Twist by [Twist screen>/Azimuth/Entity segment/Follow polyline]? F
 Select reference polylines to follow. pick a polyline
 Select objects: 1 found
 Select objects:
 Select points from screen, group or by point number [Screen>/Group/Number]? select Enter
 Select Carlson Software points.
 Select objects: pick the Carlson point inserts

Point attributes aligned by Follow Polyline option of Twist Point
**Resize Point Attributes**

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

**Prompts**

Enter point attribute and symbol size <4.0>: press Enter
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points.
Select objects: pick the point entities
Finding Carlson Software Point Attributes ....
Number of entities changed > 10

Pulldown Menu Location: Points
Keyboard Command: sizepnt
Prerequisite: Carlson points

**Fix Point Attribute Overlaps**

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.

**Methods:** There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

Alternate Layout ID 0-9
These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the Point Defaults command on the Points menu.

**Flip Individual Attributes**
This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

**Slide Individual Attributes**
This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.

**Rotate (If Only One Attribute)**
This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

**Offset Attribute Block**
This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See Offset Options below for a description of the options that can be used with this method.

**Offset Options:** These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.

- **Maximum Offset Scaler:** This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.
- **Use Leader:** Specifies whether or not a leader should be drawn when offsetting the attribute block.
- **Minimum Leader Length Scaler:** Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.
- **Draw Arrowhead:** Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
- **Minimum Leader for Arrow Scaler:** Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that the leader arrowhead should be offset from the point.
- **Arrow Size Scaler:** Specifies a scale factor to be applied to control the size of the arrowhead if drawn.
- **Use Separate Leader Layer:** If enabled, allows the user to define a different layer on which to place the resultant leader.

**Use Selection Set for Points:** Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, then all the points in the drawing are used.

**Avoid Linework Conflicts:** Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

**Review Remaining Overlaps:** Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.

**Skip Resolved Overlaps:** Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, then both resolved overlaps and unresolved overlaps will be available.
for review. This option only applies if Review Remaining Overlaps is on.

**Overlap Reviewer**

The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.

**Pan and Zoom Controls:** Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

**First, Last, Back, and Next:** These buttons allow you to step through each overlap or to jump to the first or the last.

**Status:** This drop-down list indicates the status of the current overlap. *open* means that the overlap has not been fixed yet. *resolved* means that the overlap has been fixed. *ignore* can be chosen by you to remove the overlap from the list.

**Restore:** Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.

**Move Block:** Allows you to move one or more attribute blocks in the drawing. See the documentation for *Move Point Attributes with Leader* command in the Points menu.

**Erase Attrs:** Allows you to erase selected point attributes.

**Move Attrs:** Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for *Move Point Attributes* command in the Points menu.

**Auto-Zoom:** Check this checkbox to automatically zoom and pan the view as each overlap is viewed.
Prompts

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed.
Select the points to fix overlaps with: *pick the Carlson point inserts*

Pulldown Menu Location: Points
Keyboard Command: overlappts
Prerequisite: Points in the drawing

Trim by Point Symbol

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

Prompts

Select Carlson Software point symbols to trim against.
Select objects: *select the point symbols*

![Before Trim by Point Symbol](image1)

![After Trim by Point Symbol](image2)

Pulldown Menu Location: Points
Keyboard Command: trimpts
Prerequisite: Carlson point symbols

Change Point LayerColor

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on
the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK, TRAVNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVNO1.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.

![Change Point Layer/Color](image)

The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30,32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.

**Pulldown Menu Location:** Points  
**Keyboard Command:** pntchg  
**Prerequisite:** Carlson points displayed in the graphic drawing window

### Renumber Points

This command will edit the point number attributes of a group of Carlson points. The command prompts for the user to enter the point number difference. Enter the positive or negative amount you would like to have added/subtracted from the current value. After selecting the point to change, a prompt to delete the old point number is displayed. If yes is chosen the old point number is deleted from the CRD file, if no is selected the old and new point numbers are retained in the file. This results in one coordinate position represented by two point numbers.

The following illustrates number changes from point 4, 5 and 6 to 104, 105 and 106. This prompt sequence retains both numbers in the CRD file. If the intent is to renumber and delete the original points 4, 5 and 6, then Yes would be selected when prompted to Delete old point numbers.

**Prompts**

**Positive number increases, negative number decreases Point number.**  
**Point Number difference** <1>: 100 This response would add 100 to the current point number value.  
**Select Carlson Software Points for Point Number change.**  
**Select objects:** select a point number or a group of points by window or crossing  
**Delete old point numbers from file** [Yes/No]? Choose correct response. In this example the response was No, leading to the following.
PT#: 6 changed to PT#: 106..
PT#: 5 changed to PT#: 105..
PT#: 4 changed to PT#: 104..
Number of entities changed: 3

Pulldown Menu Location: Points
Keyboard Command: renumpt
Prerequisite: Carlson points

**Explode Carlson Points**

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. **Caution:** After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:

1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if you wish).
4. Exit the drawing **without** saving.

**Prompts**

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities! The resulting points will **NOT** be useable by most Carlson Software commands!!!!

Select Carlson Software Points to Explode: select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed: 345

Pulldown Menu Location: Points
Keyboard Command: explode_scad
Prerequisite: Carlson points

**Convert Surveyor1 to CRD**

This command will convert a Surveyor1 coordinate file to the current Carlson format.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: SURVEYOR2CRD
Prerequisite: A Surveyor1 coordinate file

**Convert CRD to TDS CR5/Convert TDS CR5 to CRD**

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.
Convert CRD to Land Desktop MDB

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.

Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.
Prerequisite: An LDD point database file

Convert Civil 3D to Carlson Points
This command converts Civil 3D point entities into Carlson format point entities. When running in AutoCAD, the Civil 3D Object Enabler from Autodesk is used to read the Civil 3D point entities. This object enabler must be installed before running this routine. The installation for the object enabler is located under Support at www.autodesk.com. When running in IntelliCAD, this routine uses a conversion program from the Open Design Alliance to read the Civil 3D point entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: c3d_crd
Prerequisite: Civil 3D points in the drawing

Convert Carlson Points to Land Desktop
This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you’d like to convert.

Prompts

Convert all or selected points [All/<Selected>]? press Enter
Select Carlson Software Points to convert:
Select objects: pick first point for window selection method
Select objects: pick second point
Processing Carlson Software point...

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: pt_aec
Prerequisite: A Carlson CRD file

Convert Land Desktop to Carlson Points
This command converts Land Desktop point entities into Carlson format point entities. The Land Desktop Object Enabler from Autodesk is used to read the Land Desktop point entities. This object enabler must be installed before running this routine. The installation for the object enabler is located under Support at www.autodesk.com. Be sure to match the version of the object enabler with the Land Desktop version used to create the drawing.

Prompts

Convert all or selected points [All/<Selected>]? all. Choose which points to convert.
Point position method [Insertion/<Database>]? press Enter. Choose between the drawing insertion points or the point database for the point locations.
Locate points on Real-Z Axis [Yes/<No>]? press Enter. Choose between creating the points at their elevation or at zero.
Convert point markers to symbols [<Yes>/No]? press Enter. Choose between using a point symbol or the PDMODE.

Pulldown Menu Location: Points
Keyboard Command: ldd_crd
**Prerequisite:** LDT points in the drawing and the LDT Object Enabler

---

**Convert Softdesk to Carlson Points**

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in *Coordinate File Utilities*, this updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv  
**Prerequisite:** Softdesk points

---

**Convert Carlson Points to C&G**

This command converts a Carlson CRD file into a C&G Point file.

Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd2cg  
**Prerequisite:** A Carlson CRD file

---

**Convert C&G to Carlson Points**

This command converts C&G Points into a Carlson CRD file.

Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file.
Convert Carlson Points to Simplicity

This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button.

Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

Convert Simplicity to Carlson Points

This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.
Prerequisite: A Simplicity point file

**Convert Leica to Carlson Points**

This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in *Coordinate File Utilities*. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv3  
**Prerequisite:** Leica points

**Convert Geodimeter to Carlson Points**

This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command *Update CRD File from Drawing* in *Coordinate File Utilities*. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv4  
**Prerequisite:** Geodimeter points

**Convert Carlson Points to Ashtech GIS**

This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned off).

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2ashtech  
**Prerequisite:** Carlson Points

**Convert Carlson Points to Softdesk**

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2soft  
**Prerequisite:** Carlson points

**Convert CAICE KCM to Carlson CRD**

This command converts a CAICE .KCM point database file to a Carlson CRD file.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** kcm2crd  
**Prerequisite:** CAICE KCM file
Convert PacSoft CRD to Carlson CRD

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be displayed. Once both files have been specified, the following dialog box will be displayed.

![PacSoft Conversion Type dialog box](image)

The **No Coordinate Conversion** option converts the file format while leaving the coordinate values unchanged.  
**Convert From Meters to Feet** will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** pacsoft2crd  
**Prerequisite:** PacSoft crd file

Convert Carlson Points to Eagle Point

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.

Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2eds  
**Prerequisite:** Carlson points

Convert Eagle Point to Carlson Points

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read into the current CRD file by using the command **Update CRD File from Drawing**, found in **Coordinate File Utilities**. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv2
Prerequisite: Eagle Point points

Search Published Control

The Search Published Control command allows you to search published control mark data freely available on the National Geodetic Survey (NGS) web-site (http://www.ngs.noaa.gov) and optionally store the retrieved information to the active coordinate file.

Map Tab: Use the Map tab to navigate to a location bounded by a viewing window no greater than 2 degree of latitude by 2 degree of longitude. The limits of the current view are shown at the lower right of the Map tab (see below). To navigate to the area of interest:

- "zoom" using the slider control on the left side of the Map tab, or,
- "zoom" using the mouse wheel, or,
- "zoom window" by holding the Shift key and while left-clicking two points to define a rectangular area, or,
- "pan" by left-clicking and dragging the image to the desired position in the Map tab.

Type: Select the type of the NGS markers that are to be returned.

Order: Select the positional order of accuracy of the NGS markers that are to be returned.

Stability: Select the elevational stability of the NGS markers that are to be returned.

Symbol Size: Use the horizontal slider to adjust the symbol size of the NGS markers.

Search for Control: Click on this button to initiate the search for NGS control markers that satisfy the search criteria.
Note:

- The Search Survey Control dialog box is re-sizeable and contains re-sizeable controls.
- Order - For additional information on Order accuracy, reference http://www.ngs.noaa.gov/faq.shtml#WhatHARN: Horizontal A-order stations have a relative accuracy of 5 mm +/- 1:10,000,000 relative to other A-order stations. Horizontal B-order stations have a relative accuracy of 8 mm +/- 1:1,000,000 relative to other A-order and B-order stations. Additional information can also be viewed at http://gpsinformation.net/main/ngs-accuracy.html.
- Stability - For additional information on marker Stability, reference http://www.ngs.noaa.gov/AERO/Genspecs_A/Volume%20A/Attachment%201-6.pdf: Stability code A = expected to hold an elevation. Examples: rock outcrops; rock ledges; bedrock; massive structures with deep foundations; large structures with foundations on bedrock; or sleeved deep settings (10 feet or more) with galvanized steel pipe, galvanized steel, stainless steel, or aluminum rods. Stability code B = probably hold an elevation. Examples: unsleeved deep settings; massive retaining walls; abutments and piers of large bridges or tunnels; unspecified rods or pipe in a sleeve less than 10 feet; or sleeved copper-clad steel rods. Stability code C = may hold an elevation but subject to ground movement. Examples: Metal rods with base plates less than 10 feet deep; concrete posts (3 feet or more deep); large boulders; retaining walls for culverts or small bridges; footings or foundation walls of small to medium-size structures; or foundations such as landings, platforms, or steps.
- As NGS markers are retrieved, left-click on the marker itself to see summary information about the marker.
- To retrieve the NGS datasheet with additional information about the marker, left-click on the Identifier hyperlink. To close a "balloon" marker on the Map tab or an NGS datasheet, left-click on the "X" icon of the balloon or datasheet tab, respectively.
- If any NGS datasheet tabs are open and the OK button is clicked on the dialog box, you will be prompted if the open NGS markers should be saved to the current coordinate file.

Prompts

**Save selected stations to coordinate file?** Indicate your preference if the opened NGS control marks should be saved to the current coordinate file.
Help Menu

Carlson On-line Manual with Movies
This function launches the Internet browser to view the Carlson manual on-line. This on-line manual also includes training movies. You will need a fast internet connection to use this manual.

Serial Number Report
Carlson Software is setup (by default) to check the Carlson server for periodic updated patches (aka “service packs”). These checks are logged so that the server collects which build versions a particular machine is running. On the www.carlsonsw.com webpage, under the Support > Product Registration, there is a link for a report of this serial number information:

This tool generates a patch status report for all the computers at your company.

Product Registration

Most products may be registered online automatically. If you do not have an internet connection available, you may print out your registration form and fax it to 606-564-9525. It will be returned to you by fax within 48 hours. Some products can be registered manually using the links below. All registered products can be run for 30 days before registration is required.

Carlson SurvCE registration: go to SurvCE.com
Office Products registration
Geodetics RTD Rover registration
Carlson GIS-CE registration

Reports and lookup forms
Account-wide current serial number lookup and version check
Maintenance upgrade serial number lookup

This link goes to a webpage which prompts for the account to report. A serial number must be supplied along with either a phone number or Carlson customer ID assigned to the serial number.
A report is then generated with all the machines, serial numbers and current build numbers and last update check date for the identified account as shown in the sample below (parts of the serial numbers below have been blurred for security purposes).

### Carlson Software Update State Report

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Serial Number</th>
<th>Build</th>
<th>Date last seen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>June 2, 2010, 10:40 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100713</td>
<td>August 25, 2010, 7:44 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>November 25, 2009, 1:31 pm</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>November 25, 2009, 12:24 pm</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>April 27, 2010, 5:04 pm</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>Unknown</td>
<td>Never</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>December 14, 2009, 8:05 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100318</td>
<td>July 22, 2010, 10:38 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>March 17, 2010, 1:52 pm</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100713</td>
<td>August 11, 2010, 8:59 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100318</td>
<td>July 19, 2010, 2:13 pm</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>December 17, 2009, 9:55 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100318</td>
<td>August 16, 2010, 6:48 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>091023</td>
<td>November 18, 2009, 8:01 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100713</td>
<td>August 23, 2010, 9:39 am</td>
</tr>
<tr>
<td>Carlson 2010</td>
<td>-4F27AC0-</td>
<td>100713</td>
<td>August 15, 2010, 9:30 am</td>
</tr>
</tbody>
</table>

- The Carlson **Build Number** is essentially identical to the release date for the build as it is in the form of YYMMDD.
Survey Menu

This chapter provides information on using the commands from the Survey pulldown menu, in order to download data from data collectors, process raw data and prepare plats. The first sections of the pulldown provide information on working with data collectors, editing and processing raw data and drawing Field to Finish. Carlson SurvNET is Carlson’s Network Least Squares Reduction (NLSA) program. Below that there are complex deed creation and linework commands. The bottom portion of this menu provides features for creating cut sheets, polyline data and other survey important requirements.

Data Collectors

This command does two main functions for a variety of popular data collectors. First, this command transfers (uploads and downloads) data between the data collector and Carlson. Second, this command converts data formats between the data collector format and the Carlson format. So, if you already have the data file on the computer, you can skip the transfer function and just perform the conversion function.

The transfer function does the conversion at the same time. In most cases, the download from the data collector produces a raw (.RW5) file (field notes) and/or a coordinate (.CRD) file (coordinate points). Several of the download programs have an option to automatically run the Edit-Process Raw Data File command after downloading raw data. You can also send, or upload, a coordinate (.CRD) file. The dialog shown here appears when the menu command is selected.
Carlson SurvCE: For Carlson Software data collection programs SurvCE and SurvStar. This button produces the SurvCOM dialog and program.

Prepare Geoid for SurvCE: Creates a subset of a geoid as a .GSF file to load into SurvCE.

CG Field: For CG Field programs.


Surveyors Assistant: For data collectors running Surveyors Assistant software (Corvallis MC2, MC5 and Pentax SC5).

Sokkia SDR: For SDR2 through SDR 33 and other collectors that have a SDR format like the Trimble.

Sokkia G2: Specifically for the SDR2.

TDS: For data collectors that use TDS software (Ranger, HP48, HP95, Husky FS-2 & FS-3, Corvallis MC-V and TOPCON FS2, FC95 and FC48).

SMI: For SMI data collectors on the HP48.

Leica: For Leica GIF-10 module and Leica instruments.

Nikon: For Nikon DTM and DR-48 total stations.

Geodimeter: For the Geodimeter Geodat collector.

Topcon 210/310/220/GPT2000: Supports these Topcon models.

MDL Laser: For MDL Laser instruments.

General Kermit Transfer: For general transferring using Kermit.

Carlson SurvCE

Note: In the following text, the term SurvCE will apply to SurvCE, SurvStar, and Sokkia G2

Connect the serial cable. Select Data Transfer from the on the handheld. Choose Carlson/Carlson Survey Download. This leads to a File Transfer screen on SurvCE, which says "Awaiting Connection". All the action is on the PC side. There is no time delay in this handshake. It will wait for the PC program to catch up. When you connect the cable from SurvCE to the PC, Microsoft ActiveSync may interfere and say "Connect to PC?" If you get this question, say No or otherwise terminate the Microsoft ActiveSync linkage. Start the Carlson portion of this link by choosing Survey, Data Collectors, then the SurvCE option. If connection is automatically established, SurvCE will display, "Connected to PC".

If only the left side of the screen displays data, then you do not yet have a connection. Press the Connect button located at the bottom left of the file transfer dialog. The transfer program will respond with Retrieving File List. Once the file list has been retrieved, the left side of the dialog box will show files located in the specified path on the PC and the right side of the dialog displays the files located in the designated path on the remote. You can change directories by scrolling to the top of the file list and choosing Up One Level (just like in Windows).

To transfer one or more files, simply select or highlight the desired files and select the transfer button. More than one file can be transferred from the remote to the PC or from the PC to the remote during the transfer process. Standard Windows selection options apply. For example, selecting one file and then while pressing the shift key on the PC, selecting another file deeper on the list will select all the files in between the first and last selected. You can also select the first file to transfer and press and hold down the shift key and use the down arrow to specify the range of files to transfer. Pressing and holding the control key on the keyboard allows for the selection of multiple files in any selection order, by picking the files with the left mouse button.

After the files have been selected, press the transfer button. When the transfer is complete, the program will return a "Transfer Complete" message, and will then proceed to update the file lists on the PC and the Remote.
The following information describes the buttons on the bottom row of the SurvCOM dialog box. The button name is on the left in bold:

**Connect:** After selecting Data Transfer in SurvCE, press this button to start the connection. Once connection is made, the status line on the file transfer utility dialog box will show Connected to the remote machine.

**Transfer:** Pressing this button transfers selected files from either the Remote to the PC, or the PC to the Remote.

**Set Path:** This option allows for the specification of the desired source and destination drives and folders for both the PC and the Remote device. For example, if you were downloading, or copying files from the Remote device to the PC, to specify a source path on the remote device, select the Remote Machine toggle and then type in the desired path in the path field. To specify a destination path on the PC, select the Local PC toggle and type in the desired path the path field. When a change to either path is made, the transfer utility will retrieve a new file list from the specified paths.

**Make dir:** This option allows for creation of directories on both the PC and the Remote device. Specify the hardware on which to create the directory and then enter the directory name.
Delete: This option allows you to delete the tagged files. To delete a file, select the file to delete by clicking on the file, press the delete button at the bottom of the dialog. Confirm deletion by selecting the appropriate response on the Delete File dialog.

Rename: To rename a file, click on the file to rename and select the rename button at the button of the dialog. On the dialog that displays type in the new name and press the OK button.

Options: This command allows you to set various options for data transfer. The dialog shown below will appear.
Com Port: You must select which com port on the PC to use.

If you are transferring data via a USB port, set the com port to ActiveSync, see the Options section below for procedures to change com ports. To transfer data using an USB port a connection between the Remote and PC using ActiveSync is required. In ActiveSync verify that the "Connect Settings" have been set to "Allow serial cable or infrared connection to this Com port" and Allow USB connection with this desktop computer. This will allow for connection using an USB port or a COM port connection. Both will use ActiveSync to transfer data between devices.

File Mask: You must select a file filtering syntax. This filter allows for the setting of specific file types to display. For example if you only wanted to see CRD files the filter would be *.CRD.

Directory Sort: You must select how to sort the list of files.
**Display Special Files:** Toggle whether or not you should see special files.

**Confirm Overwrite:** Check this to confirm before overwriting files.

**Baud Rate:** You must choose the baud rate for transferring data.

**Protect Remote Files:** Check this to protect files on the mobile device.

**Archive RW5 Files:** With this option set to YES, when downloading rw5 files, a second copy of the file will be made with a .SC5 extension to serve as an archive of the original rw5 file.

**Geoid:** This command will carve out a portion of the Geoid 99, EGM96, Canadian CGC2000, Canadian HT2.0, Canadian HT 1.01, Australian GDA94, Great Britain OSG-MO2 and Geoid 2003 grid files, and send it to SurvCE. Since these geoid grids are very large, this carves out a precise portion of it and avoids overloading the memory on the remote device running SurvCE. You will be prompted for the directory on the PC of the source Geoid grid file, the approximate latitude and longitude of the job, and the size of the area desired in miles, kilometers or degrees of latitude and longitude. To define a Geoid area, make sure that this criteria is met:

1. Specify the location of the geoid grid files.
2. Specify the geoid type.
3. Enter the latitude and longitude near the center of the job area.
4. Specify the Grid size either in miles, km (kilometers), or deg (degrees).
5. Name the grid file.

The file will be transferred to the data collector and placed in the appropriate place for use.
**F2F conv:** This converts the more thorough and detailed Carlson field code file (for field-to-finish work, *.FLD) to the more simplified Feature Code List that runs in SurvCE (*.FCL). The Feature Code List in SurvCE (not SurvStar or Field) handles Linework (on or off), Line Type (2D or 3D), Layer (= Code) and Full Text (Description). Select the Carlson field code (*.FLD) to convert, the conversion takes place and the file is transferred and located in the correct location for use in the data collector.

![Select Existing Field Code Table](image)

**Send Pnts:** This option allows for the uploading of a user specified point number range out of the selected crd file to unload. Use the Select button to specify the crd file to upload. The Remote File Name will default to the name of the crd file selected to upload. You can change this name if needed. Specify the Point Range to Send and select the OK button.

![Send Range of Points](image)

**Exit:** This command will exit the File Transfer Utility

The following information describes the buttons on the Data Collection Programs dialog box that come after the Carlson SurvCE button, moving from left to right and then from top to bottom. The command/button name is on the far left margin, in bold:

**Prepare Geoid for SurvCE**

This function creates a .GSF (Geoid Separation File) for SurvCE from a built-in geoid. Most geoids are very large and this routine carves out a subset of the geoid by specifying a center position and area size. The geoid data files are not included in the regular install since they are so large. Instead, the program automatically downloads them as needed from the Carlson server. You can also install them separately by running the CarlsonGeoidGrids.exe from the Support->Other Downloads on www.carlsonsw.com.
To transfer data to and from data collectors using CGField software, first make sure that the Baud Rate is set to 9600 and the Parity is set to NONE then follow the steps outlined below.

**Receiving a Coordinate File from CGField**

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 4, "Send Coords"
3) Select the Coordinate file to send.

Stop here in CGField and go to Carlson.

Carlson:

Leave the FILE fields blank.

Press the "Download Coordinates" button to ready Carlson to receive the file.

Stop here in Carlson and go back to CGField to complete the transfer process.

CGField:

Select the points to send
1) For All points
2) To select Blocks of points.
3) From .PTS file (the set of points in a Batch Point File).

The coordinates will be transferred. After the transfer is complete, you will be asked for the CRD file name. The C&G CRD file will automatically be converted to a Carlson CRD file. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Receiving a Raw Data File from CGField

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 2, "Send Raw Data". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download Raw" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:
Select the raw data file to be sent. The transfer will begin.
The C&G .RAW file will be transferred and saved in the data folder. After the transfer is complete, you will be asked for the RW5 file name. The RAW file will be automatically converted to a Carlson RW5 file.

Receiving an ASCII file from CGField

This will allow you to transfer a C&G report file (RPT) or an ASCII NEZ file to Carlson.

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 6, "Send ASCII". Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download ASCII" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.
Select the ASCII file to send.

After the transfer is complete, you will see the file in the Carlson editor. You can then select FILE and SAVE (or SAVEAS) to save the ASCII file.

**Sending a Coordinate File to CGField**

**CGField:**
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 3, "Receive Coords" to ready the data collector. Stop here in CGField and go to Carlson.

**Carlson:**
Leave the FILE fields blank.
1) Press the "Upload (Send Carlson File)" button.
2) Select the Coordinate file.
3) Select the points to send.
4) Press the "Start Transfer" button.

**CGField:**
Carlson will send the file name to CGField and a coordinate file with the same name will be automatically created or opened in CGField.

If the file exists you will be asked how you want to handle duplicate points:
1) Overwrite
2) Don't Overwrite
3) Ask for each Point

The point transfer will begin.

**Convert CG .RAW to Carlson .RW5**

This utility allows you to convert a C&G raw data file to a Carlson raw data file. Select the C&G .RAW file to convert. Then enter the file name of the destination Carlson RW5 file.

**Thales/FastSurvey** You will be taken directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**Surveyor's Assistant**

**Download**

From the Surveyor's Assistant data collector, go to the Transfer routine from the main menu. Fill out the transfer screen as follows:

- **Direction:** OUTPUT
- **Format:** LIETZ
- **Data:** Coordinate or All Data
- **Port:** COM1 or COM2 Chk Hold: NO
- **Protocol:** NONE

You should also check the settings under the PORT menu. Typical port settings are baud=9600, parity=none, data=8, stop=1 and handshake=XON/XOFF. Now in Carlson, run *Data Collection* in the Survey menu and choose Surveyor's Assistant. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to Surveyor's Assistant and press GO. The file transfer should now go. If the All Data option is used, then the Leitz format will contain both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point
Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the Surveyor's Assistant. First go to the Transfer routine on the main menu. Fill out the screen as follows:

Direction: INPUT
Format: LEITZ
Port: COM1 or COM2
Protocol: NONE

Go back to Carlson and choose Surveyor's Assistant from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to the Surveyor's Assistant and hit the GO function key. The Surveyor's Assistant is now waiting to receive so return to Carlson and click OK on the range of point dialog. The file transfer should now go.

Sokkia SDR
This routine applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other collectors that have SDR format transfer such as the Trimble and C & G.

Download
From the SDR data collector, go to the Communications routine from the main menu. Choose Data Format SDR. Next hit the Send function key. Then choose Select Jobs. From the list of jobs, highlight the job to transfer and set it to Yes with the arrow keys. Now in Carlson, run Data Collection in the Survey menu and choose Sokkia/SDR. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SDR and press OK. The file transfer should now go. The SDR format contains both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. The original SDR transfer file is stored on the computer as a RAW file. When the transfer is
complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified
a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data
before downloading the point from the data collector.

The SDR-33 has different modes for storing and transferring data. In coordinate mode, the download will create
points in the coordinate (.CRD) file and the raw data (.RW5) file will only contain some basic header lines. In the
raw data mode, the download will create all the measurement data in the raw file and no points will be created in
the coordinate (.CRD) file. For this raw data mode, you will need to run Edit-Process Raw Data File in the Survey
menu to calculate the points from the raw data. The third mode in the SDR-33 creates both raw data in the raw data
(.RW5) file and points in the coordinate (.CRD) file. The Include Time Stamps in Notes option sets whether all
the date-time records for each point are put in the raw data (.RW5) file as description records. The Include Point
Attributes in Notes option will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate (.CRD) file.

Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the SDR. First go to the Communications
routine on the SDR main menu. Choose Data Format SDR. Go back to Carlson and choose Sokkia/SDR from the
Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the
Carlson dialog, pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD)
file to send. Then click the Upload button. Then a Sokkia Options dialog appears for setting the job parameters for
the file to be created on the collector. Be sure to choose the Distance Unit that matches your coordinate (.CRD) file
(meters, US feet or international feet). Click OK and the next dialog now allows you to specify the range of point
numbers to upload. Before clicking the Start Transfer button for range of points, go to the SDR and hit the Receive
function key. The SDR is now waiting to receive so return to Carlson and click Start Transfer on the range of point
dialog. The file transfer should now go.

Communication Settings
Besides matching the baud rate between Carlson and the collector, make sure that the collector is set to word length
of 8 and 1 stop bit under the communication settings.

Print File
The Receive Sokkia Print File downloads a print report from the SDR33 data collector. This file is only used for
printing report purposes in Carlson. This file is not used by Carlson to generate coordinate (.CRD) files or raw files.
The first step is to choose Data format=Printed in the Communications menu of the SDR33. Next pick the Receive Print File button in Carlson. Then on the SDR33 choose the Send function and select a job to send. At this point the file is transferred. After downloading, the job report is displayed in the Carlson standard report viewer.

Example of Sokkia Printed Format:

```
SDR33 V04-04.25 (C) Copyright 1998 Sokkia May-29-80 23:39 01/29/1999
Angle Degrees  Dist Feet
Temp Farenht  Coord N-E-Elev
JOB TRAV  Point Id Alpha (14)
Atmos crn No  C and R crn No
Record elev Yes  Sea level crn No
POS TP 1 North 10050.000  East 10000.000  Elev 0.000
POS TP 2 North 10000.000  East 10000.000  Elev 0.000
POS TP 3 North 9515.636  East 9551.975  Elev 37.611
Code T3
POS TP 403 North 4967.527  East 5074.632  Elev 0.000
NOTE TS Jan-01-80 00:14
```

**End of report**

Sokkia G2 This routine takes you directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**TDS**

**Download [HP-48 and Husky]**

In the TDS program, go to the File Transfer routine. Choose the type of data to transfer (CRD or RAW). Next pick the Send function key. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Download [Ranger and Windows CE]**

In the TDS program, go to the Transfer routine and pick the Send File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. In the Type field of the file selection dialog, choose Coordinate Files or Raw Files. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS and pick OK in the TDS dialog. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Upload [HP-48 and Husky]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the File Transfer routine. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

Upload [Ranger and Windows CE]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the Transfer routine and pick the Receive File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

SMI
Download
To send point data from the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TOPC] [COMM]. In SMI version 6 or later, type [Job][KERM][SEND]. Also in version 6, make sure that the first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. The [NE] stands for North-East coordinate order which is the format that Carlson expects. Also in the [Job][KERM] screen, make sure that the second function key reads [COMM] and not [SPACE]. The [COMM] stands for comma separators. Then enter the first point to send followed by the last point to send but before pressing Enter for the last point go to Carlson. Run Data Collection in the Survey menu and choose SMI. Check that the COM port
and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SMI and press Enter for the last point to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. To send raw data, use the [Print][Raw] routine in SMI along with the same Carlson procedure used for point data.

**Upload**

From the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TO48] [COMM]. In SMI version 6 or later, type [Job][KERM][RECV]. Also in version 6, make sure that first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. Then enter the first point to send followed by the last point to send. Next enter the job name but before pressing Enter go to Carlson and run SMI under *Data Collection* in the Survey menu. In the Carlson dialog, specify the same job name as entered in SMI. Next pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the same range of points as entered on the SMI. Go back to SMI and hit Enter for job name followed by clicking the OK button for range of points in Carlson. The file transfer should now go.

**Leica**

There are two types of Leica transfers: GIF-10 and GeoCom for all other Leica instruments. The type is set in the Equipment Type field on the main dialog. For transferring with the Leica instruments, the GeoCom program shows a dialog of the available COM ports on your computer. On the first time that you transfer to an instrument, you will need to pick the Instruments button and register the instrument from the list. Pick the Port Settings button to make sure that the communication settings match the instrument.

To download a file with GeoCom, make sure that the instrument is ON and connected to the computer by serial cable. The instrument also needs to be in GeoCom mode. Then pick the Download in the Carlson dialog. In the GeoCom program, open the computer COM port that the instrument is connected to by picking the ‘+’. Then open the Memory Card and GSI folders. Next select the file to transfer and click the OK button. With Point Protect on,
the routine will check the coordinate file for existing point data before downloading the point from the data collector.

To upload a file with GeoCom, specify the file name to be created on the instrument in the Leica File field and pick the Upload button in the Carlson dialog. Then the program will prompt for the range of points to transfer. Fill out the range and pick the Start Transfer button. Then the GeoCom program will start. Open the computer COM port by picking the ‘+’. Then open the Memory Card folder and highlight the GSI folder and click OK.

The upload and download file transfer works with the GIF-10 data collector. The GIF-10 communication settings should be the following:

- Baud: 9600
- Parity: NONE
- Protocol: NONE
- Stop Bit: 1
- End Mark: CR/LF
- Connected As: Some computers use DCE and others use DTE

![First Leica dialog](image1)

First Leica dialog

![When Leica 1200 Series is chosen](image2)

When Leica 1200 Series is chosen
Download
From the GIF-10, go to the file transfer routine. Then go to Carlson and run Data Collection in the Survey menu and choose Leica. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to GIF-10 and select the file to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
From the GIF-10 data collector, go to the file transfer routine. Then go to Carlson and run Leica under Data Collection in the Survey menu. In the Carlson dialog, specify the job name in the Leica File field. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to GIF-10 and start the receive by highlighting Receive and pressing the Run button. The GIF-10 now shows the available job numbers. Choose a job to receive the transfer using the arrow buttons and then press the Run button.

Converting
Carlson supports raw and coordinate data collected using three different Leica Operation Codes: Wildsoft and 10-20-30-40 as well as the newer LISCAD. Moreover, data could be in the GSI8 format or the newer GSI16 format. Some example files are shown here.

**GSI8 format data file using LISCAD Operation codes:**
WILD GIF-12
410149+00000001 42....+00005003 43....+00005.42 44....+00005.25 45....+00005000
110150+00005000 21.324+35959480 22.324+09238590 31..<01+00228271
410151+00000005 42....+00010100
110152+00005001 21.324+35156390 22.324+09303500 31..<01+00133532
410153+00000005 42....+00070100
410154+00000014 42....+0000ELM
Leica raw files usually have a .RAW or .GSI extension. The primary difference in the GSI8 and GSI16 formats is that information is contained in data blocks of 16 characters in the GSI16 format, while it is contained in blocks of 8 characters in the GSI8 format. Leica instruments make it possible to have both the GSI8 as well as GSI16 data formats in the same raw file. However, lines with the GSI16 format data will always start with an asterisk (*) character, to distinguish them from the GSI8 format. There is no distinction between Leica raw files collected in the Wildsoft and LISCAD operation codes.

**Supported Wildsoft codes:**

1: Start Job  
11: Assign Coords  
12: Coord Offset  
13: Target Height  
14: Add to Tgt Ht  
15: Add to Meas Dist  
2: Occupy Point  
21: Occupy Saved Point  
3: FS to Trav Pt  
31: FS to Single Pt  
32: Radial Sideshots  
33: Sets of Angles  
4: Closing Pt  
41: Closing Angle  
50: BS to Benchmark
51: FS to Turn Pt
52: BS to Turn Pt
53: FS to Benchmark
60: Save Point
61: Recall Point
62: Compare Point
63: Remark

Supported LISCAD codes:
1: New instrument setup
2: New target height
3: Sets of directions
4: Fixed azimuth
5: Feature code
6: Measured offset
8: Line creation for sub-codes 1 (straight string), 2 (curved string) and 6 (arc by 3 points)
9: Fixed coordinates
11: Close string
14: Additional description
20: Start of job
27: Feature code
90: Split feature code
100+: Descriptions

The Convert button can be used to convert any Leica format file into a Carlson format file. For example, if you have a Leica PCMCIA card then there is no serial cable transfer to do. Instead use the Convert routine to make the Carlson raw data (.RW5) and coordinate (.CRD) files. Since there is no distinction between Wildsoft and LISCAD files, the user must know in advance which format has been used in the file. Then, select that particular option (Wildsoft, 10-20-30-40 or LISCAD) under the "Coding System" option at the bottom of the dialog box, as shown in the previous page. Another option that the user needs to choose is the order in which foresight-backsight readings have been recorded in the raw file, BFFB or BFBF, as explained in the dialog box. Then, the user can simply pick the "Convert" button and the program prompts for the input "Wild/Leica File" (raw file), and the output "Carlson RW5 file" and "Carlson CRD file", if they are not already filled.

Nikon

Download
First choose the equipment and data type under the Transfer Type list. Also check that the communication and data format settings match your collector. Then click the Download button and follow the on-screen directions. When the transfer is complete, the program will ask you for the Carlson coordinate file (.CRD) and raw file (.RW5) to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. The original data from the collector is stored in a file name with the same name as the coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

Upload
Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Set the points and then click the Start Transfer button. The file transfer should now go.
Convert Nikon to Carlson
The Convert button will translate the Nikon raw file format (.TRN or .RAW) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Portion of typical Nikon file format:**
```
MP,1,,5000.0000,5000.0000,0.0000,T/1
ST,1,,2,,0.0000,0.00000,0.00000
SS,3,0.0000,152.1510,359.59590,90.44100,11:43:38,T/2
SS,4,0.0000,127.5560,0.06040,90.40110,11:44:45,CON
SS,5,0.0000,97.1820,2.19580,90.52460,11:45:43,CON
```

Geodimeter

**Download**
From the Geodimeter data collector, go to the file transfer routine by pressing the PRG (Program) key and entering program 54. Then choose Imem (option 1) as the source. Next choose the file type to send as either Job (measurement data) or Area (point data). The Geodimeter will then prompt for the job name. Next enter Serial (option 3) as the destination. A confirmation screen appears showing the serial port settings. Here are some typical settings:
```
COM=1,8,0,9600
```
Before pressing enter (ENT key), go to Carlson and run **Data Collection** in the Survey menu and choose Geodimeter. Then click the Download button and within 15 seconds, go back to the Geodimeter and press Enter. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate file and raw file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Upload**
In Carlson, run Geodimeter under **Data Collection** in the Survey menu. Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly.
and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the points to send but before clicking OK, go to the Geodimeter data collector. Start the file transfer routine by pressing the PRG key and entering program 54. Then choose Serial (option 3) as the source. The Geodimeter will display the serial port settings. Check these values and press enter. Next choose Area (option 2) as the destination. Then enter the job name. The Geodimeter is now listening for data. Quickly go back to Carlson and click OK on the points to send dialog. The file transfer should now go

Convert
The Convert button will translate the Geodimeter raw file format (.OBS) into Carlson coordinate (.CRD) and raw (.RW5) files.

Communication Settings
If the Geodimeter is not communicating with Carlson, run function 79 on the Geodimeter and make sure that it is set to 4. This setting is for the transfer message end of sequence format.

Supported Geodimeter Codes
The following Geodimeter codes are processed when converting the Geodimeter raw file. All other codes are recorded as descriptions in the Carlson rw5 file.
0=Info
1=Data
2=Station No
3=Instrument Height
4=Point Code
5=Point Number
6=Signal Height
7=Horizontal Angle
8=Vertical Angle
9=Slope Distance
11=Horizontal Distance
17=Horizontal Angle
18=Vertical Angle
21=Horizontal Reference Angle
30=Atmospheric Correction
37=Northing
38=Easting
39=Elevation
40=Delta North
41=Delta East
42=Delta Elevation
45=Correction To Bearing
46=Standard Deviation
50=Job Number
51=Date
52=Time
53=Operator
54=Project Id
55=Instrument Id
56=Temperature
60=Shot Id
61=Activity Code
62=Reference Object
70=Entered Radial Offset
71=Entered Angle Offset
72=Calculated Radial Offset
73=Calculated Angle Offset
74=Air Pressure

Portion of typical Geodimeter file format
5=108
4=13POC
6=5.000
7=238.0708
8=89.2236
9=440.39
37=767.42
38=4626.07
39=699.795

**Topcon 210/310/220/GPT2000**

This command supports these above Topcon models.
MDL Laser

The MDL Laser outputs a raw file of angles, distances and codes as one long string of data which can be converted into a Carlson raw data (.RW5) file. There is no coordinate data in the MDL raw file. So you need to run Edit-Process Raw File to calculate coordinates from the raw data. The Download button will transfer the MDL raw data from a BDI logger.

Kermit

Kermit can be also used for transferring files with accuracy. The dialog looks like this:
Pulldown Menu Location: Survey
Keyboard Command: datacolt
Prerequisite: None

Edit-Process Raw Data File

This program reads or creates a raw data (.RW5) file that contains various lines of data (records) that could be likened to a surveyor's field book. You can specify point coordinates, job information, notes, and the angles and distances that make up traverse or sideshots records. Once the raw data is created or read it can be processed/reduced to coordinates that are stored in the current coordinate (.crd; .cgc; .mdb; .zak) file.

The raw file can also be created or appended using the Locate Point, Traverse, Sideshot, and Inverse commands on the COGO menu. To store the data inputs from these commands into a raw file, first toggle on the Raw File ON/OFF command on the COGO menu. It is possible to always have the raw data file open to store data inputs. To enable this option, choose Configure from the Settings menu, then choose Survey Module, then choose General Settings. Turn on the Automatic Raw File toggle in this dialog.

The raw files created by TDS data collector programs are also compatible without conversion. The command Data Collectors on the Tools menu has options for reading other data collectors native file formats and converting them to raw data (.RW5) format. Within the raw data editor, the File menu includes an import menu for converting raw data from other formats.

When you select the Edit-Process Raw Data File command you are prompted to specify the name of the raw data (.RW5) file. The current coordinate file is used automatically. To change the current coordinate file, use the Set Coordinate File command in the Points menu before starting this command. If no coordinate file is current, the program will prompt you to set the current coordinate (.CRD) file.

Edit-Process Raw Data File uses a spreadsheet for editing the raw data as shown. Each row of the spreadsheet is represented by a number located at the far left side of the editor. Various messages and reports often reference possible problems with the data by this row number. Each row of the spreadsheet represents one record of data. There are 14 types of data records. The type of data record is shown in the first column. Different record types use different numbers of columns. Whenever the data record type changes between rows, a record header is added to the spreadsheet that describes each column of data in the following row. To edit the raw data, simply highlight the cell and type in the new value. To change the type of record, pick on the down arrow in the first column and choose a new data type from the list. To delete a row, highlight any cell in the row and hit the Delete key or choose Delete Row from the Edit menu. Records can be added pressing the Insert key, pressing the down arrow key from the last
line in the spreadsheet, or by choosing one of the add records from the Add menu.

The different record types are described below.

**TR (Traverse)**
The traverse record contains the occupied point number, foresight point number, angle mode, horizontal angle, distance, vertical angle and description. When processed, this record will calculate and store the coordinates for the foresight point. Traversing also moves the setup by making the traverse foresight point the next occupied point and the traverse occupied point becomes the next backsight point. The different angle codes are NE for northeast bearing, SE for southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle right, DL for deflection angle left and DR for deflection angle right. To set the angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical angles should be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes and 5 seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90 degrees level) or elevation difference. The vertical angle mode is set in the Display menu. The distance mode is also set in the Display menu as either slope or horizontal distance. The description field is used as the foresight point description.

**SS (SideShot)**
The sideshot record is the same as the traverse record except that sideshot does not move the setup.

**HI (Instrument and Rod Height)**
This record sets the instrument and rod heights used in elevation calculations. This record should precede any traverse and sideshot records that you want the heights applied to.

**BK (BackSight)**
The backsight record contains the occupied point number, backsight point number, backsight azimuth and the set azimuth. This record should precede any traverse and sideshot records that use this setup. If no backsight point is entered, the program uses the backsight azimuth to turn angles from. The Set Azimuth is the circle reading of the instrument when sighting the backsight. A Set Azimuth of zero is the default.

**PT (Store Point)**
The store point record consists of a point number, northing, easting, elevation and description. When processing, this data will be stored as a point in the coordinate file. If the first Occupied point and/or the initial Backsight point
are not defined in the coordinate file set for processing to, both points will need to be added to the rw5 file as PT (Store Point) records.

**DS (Description)**
The description record is an additional note that appears in the spreadsheet editor and printouts. This record can contain various information that is recorded in data collectors during field operations. This data can vary from user, temperature and general data to each line of data associated with "Set Collection". When "Sets" of data collected using various brands of data collection software is converted/imported into the raw editor, the actual measurements made during the spinning of the angles and distances are recorded as DS records and the mean value of the angle and distance is recorded as a SS record. DS records are not used in processing.

**CL (Closing Shot)**
The closing shot record is the traverse record where the foresight point is the closing point for the traverse. This record is used by the adjustment commands in the Process menu. There should be only one CL record in each Traverse loop (Name Record) in the raw file. If there is no CL record, the process adjustment routines will prompt for which shot is the closing shot. The closing shot can also be define in the field by using special codes defined in the Open Settings found under the File pulldown within the editor. Please refer to the "Open Settings" documentation below for more information on these codes.

**AB (Angle Balance)**
The Angle Balance record is the measurement data observed that closes the angles of the traverse. Typically this record is the measurement data recorded from the closing shot to the initial backsight point. The backsight could be either external or internal to the traverse. Angle Balance routine in the Process menu uses this record and compares the angle between the occupied point and foresight point of this record with a user-specified reference angle. There should be only one AB record in the raw file. If there is no AB record, then the Angle Balance routine will prompt for which shot to use as the angle balance.

**CL + AB (Closing Shot and Angle Balance)**
This record is used as both the closing shot and angle balance records.

**FD (Foresight Direct)**
The foresight direct is a traverse record used in a direct and reverse set. When the program finds one the of direct-reverse measurement records, it will look for the other three records to complete the set.

**FR (Foresight Reverse)**
The foresight reverse is a traverse record used in a direct and reverse set.

**BD (Backsight Direct)**
The backsight direct is a traverse record used in a direct and reverse set.

**BR (Backsight Reverse)**
The backsight reverse is a traverse record used in a direct and reverse set.

**EL (Elevation Only)**
This record sets the elevation in the CRD file for the specified point number. Often used when an existing point with good vertical control is being traversed through. Using this record type for the point would keep the elevation from changing on the existing point regardless of the measurement data.

**AZ (Azimuth Only)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**CSE (Control Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**SSE (Set-up Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.
MSE (Measurement Standard Error)
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

NAME (Traverse Name)
This record acts as an identifier for the group of records that make up a traverse. All the records after the NAME record belong to that traverse up to the next NAME record or the end of the file. This record allows you to have multiple traverses in one raw file. When running one of the Process commands, the program will bring up a list of all the traverse names. Simply choose which traverse to process. If you have only one traverse in the raw file, then you don't need the NAME record.

GPS
This record contains the Latitude and Longitude of a point as measured by GPS surveying equipment using Carlson SurvCE data collection software. This record has additional information tied to it such as localization files, geoid files, coordinate projection systems etc. This record has its own processing routine in the Process pulldown within the editor. Processing procedures are discussed in the Process (Compute Pts) pulldown documentation.

Raw Data Editor Pulldown Menus

File Menu

Open RW5 File
This command prompts for a rw5 file to load into the editor.

New RW5 File
This command clears the editor spreadsheet.

Save RW5 File
This saves the rw5 file. If the file hasn't been named you will be prompted for the file name and the location to save the file. After you perform the first save, this command acts as a quick save and saves the file to the name and location specified during the initial saving of the file.

Save RW5 As
This command saves the raw editor data in the spreadsheet to a rw5 file and always prompts for file name and location to save.

Open CRD File
This command prompts for an existing coordinate file to set as the active coordinate file for the raw editor.
**New CRD File**
This command prompts for a new coordinate file to set as the active coordinate file for the raw editor. The coordinate data will be initialized as empty.

**Save CRD File**
This command saves the current coordinate data in the raw editor to the current coordinate file.

**Save CRD As**
This command saves the current coordinate data to a specified coordinate file name.

**Report/Print**
There are three types of reports: Raw Data, Coordinates and Summary. A sample of the raw data report is shown below. This report shows the data from the raw editor spreadsheet. The Coordinates report lists the point data (point number, northing, easting, elevation, description) from the current coordinate file. The summary report groups the traverse, sideshot and store point numbers along with a list of the setups and the shots from each setup.

```
Raw File> c:\data\survey.rw5
CRD File> c:\data\survey.crd

Note
Survey Example
PntNo Northing Easting Elevation Desc
  1  5000  5000    100 START
OcPt BsPt SetAzi 1
  InstHgt RodHgt 5.32  6.0
  OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR  1  2 AR 268.5330 711.420 89.4050 P2
  InstHgt RodHgt 5.43  6.0
  OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR  2  3 AR 262.5448 457.760 89.3236 P3
  InstHgt RodHgt 5.4  6.0
  OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR  3  4 AR 208.5710 201.310 89.1803 P4
TR  4  5 AR 247.1657 497.120 88.5235 P5
TR  5  6 AR 277.4835 223.980 90.2926 P6
TR  6  7 AR 92.4113 233.880 90.2746 P7
  InstHgt RodHgt 5.42  6.0
  OcPt FsPt HorzAngle SlopeDist ZenithAng Desc
TR  7  8 AR 261.2756 387.250 91.4405 CLOSE
SS  7 19 AR 289.3456 112.450 91.3423 SS1

Report/Print Settings
This dialog has settings for the report functions.

![Print Settings window](image)
```
Import
These routines convert raw data from other formats into the current Carlson RW5 format. The converted raw data will be added to the end of any existing data in the editor. In many cases, the raw data file to import can be downloaded directly from the data collector or instrument using the Data Collectors command. The following supported formats (along with their standard file extension) are listed here. Some Sample File Formats are listed at the end of this section.

C&G (.CGR; .RAW; .TXT; *)
CalTrans (.DMP)
Carlson (.RW5)
EFB (.RAW; .OBS) Electronic Field Book
Fieldbook (.FBK): From Softdesk, Land Development Desktop or Civil 3D. The import handles the following record types:
AD
AZ / AZM / AZIMUTH
B / BRG / BEARING
BEG / BEGIN
BS / BACKSITE / BACKSIGHT
C3
END
F1
FC1
NE / NEZ
PRISM
STN / STA / STATION
ZD

Geodimeter (.OBS; .RAW; job; *)
Horizon (.RAW)
LandXML (.XML): LandXML is the industry standard data format for exchanging project data. It can contain any number of different data types including surfaces besides raw measurements.
Leica (.GSI; .RAW; GRE): This reads the Leica raw file in Wildsoft, Liscad, 10-20-30-40, C&G, or GeoComp format. There are options to specify direct-reverse shot order if any and to convert from International Feet to Leica US Feet.

Maptech (.FLD)
MDL Laser (.CDS)
The import handles the following StarNET record types:

- E - Elevation record
- C - Coordinate record
- B - Bearing / Azimuth record
- M - Measurement record
- SS - SideShot record
- TB - Begin Traverse record
- T - Traverse record
- TE - End Traverse record
- DV - 3D Distance Record (creates a slope distance/zenith angle record)
- D - 2D Distance Record (creates a horizontal distance)
- A - Horizontal Angle Record (creates an angle-only record)
- V - Zenith Angle record (creates a zenith angle-only record)

When parsing these records, if a measurement, coordinate or azimuth has standard errors assigned to it, then standard error records are created in the RW5 file so none of that information is lost.

The import also handles

the following DOT commands:

- .ORDER - Specifies point order (AtFromTo or FromAtTo) in the measurement record, and/or the order of NORTH/EAST or EAST/NORTH in control records.
- .DELTA - Specifies whether the data is SlopeDist/Zenith or HDist/VDist. The default is SD/ZE.
- .2D / .3D - Specifies the data format. Without this information the fields can be confused while parsing.

SurvCOGO (.RAW or .TXT)
SurvCE Archive (.SC5) When downloading a rw5 file from SurvCE using SurvCOM, there's an option to copy the rw5 file to a sc5 file as a read-only backup.

Survis (.RAW)
TDS (.RW5; RAW)
Topcon (raw;*)
Trimble (.dc)
3TA5 (.TXT)
Zeiss (.DAT)

Export
These routines convert the Carlson raw data (.RW5) file to other formats. The following file formats are supported.

CalTrans (DMP)
Fieldbook (.FBK): This export routine provides an option to "Setup Fieldbook Codes". This allows the user to substitute the raw description contained in the rw5 file with the fieldbook code used in AutoDesk Land Desktop or Civil 3D.
This export routine provides an option to "Setup SDMS Codes". This allows the user to substitute the raw description contained in the rw5 file with the SDMS codes used in SDMS program.

Open/Save Settings
This option allows for defining codes that represent the closing shot and angle balance shot of a traverse. These codes can be entered in the description of a point while in the field. When the rw5 is opened in the raw file editor, the measurement data containing the closing shot code will be set to a CL record and the measurement data
containing the angle balance code will be set to an AB record. This allows for quick processing of the survey data and saves the time spent setting up the file for processing.

Exit
Exits the raw file editor.

Edit Menu

Undo: This command undoes the last data entry or the last copy, cut or delete command performed on keyboard entered data only. This will not undo a change to the Type or Code columns, nor a cut or copy command to a row.

Cut: Standard windows cut command. Removes data from editor and places it in the windows clipboard.

Copy: Standard windows copy command. Copies selected data to windows clipboard.

Delete: Deletes selected data or row of data. Will not delete headers if data is present below the header.

Find: Tool to search and find a particular word, letter, numeric value or a combination of all. Provides options to Match whole word only and/or case. Allows for a up or down directional search from the active cell in the editor. The Point Number Search allows you to search for occupy or foresight point numbers.
**Replace:** Tool to search and replace a particular word, letter, numeric value of a combination of all. Options to Match whole word only and/or case is provided for the search criteria. Provides further options to Replace individual items one at a time or to Replace All.

**Go To:** Tool to advance the focus of the active cell to a specified line number.

**Delete Row:** This command deletes the row containing the active cursor or cell. You can delete a row by placing the cursor in any of the cells in the row that you wish to delete, or by picking on the row number at the far left of the editor.

**Modify Measurements:** This option allows for a change in distance, horizontal angle, vertical angle or lat/lon by a specified amount for the entire file or for a specified point number or line number range. To modify a measurement, choose which field to modify, enter the change in either distance or angle in dd.mmss format. The Distance Factor method multiplies the distances by the specified value which can be used to convert distance units between feet and meters or to apply a scale factor. The Lat/Lon/Z Delta can be used to adjust GPS records in case of a shift due to adjusting the base position. Next choose how to apply the modification. If all is selected, the change will be applied to all records in the specified field. If By Point Number is chosen, enter the point number or range of numbers in the Range of Points field. If by Line Number is chosen, then define the area for the change by specifying the Starting and Ending line.
Convert Points To Notes Records: This function converts point (PT) records to note (DS) records. This leaves the information of the point coordinates in the rw5 file as display only and without having the point coordinates stored to the coordinate file when the file is processed. The point data in the DS records can be converted back to PT records by picking the Code field in the spreadsheet and switching DS to PT.

Edit Coordinate File: This option allows for editing and/or listing of the coordinate data in the active coordinate file. The active coordinate file is displayed in the Header of the raw data editor. This routine brings up the edit point dialog and allows editing of the points one at a time.

Display Menu
**Angles:** This option chooses the angle format between degrees/minutes/seconds (dd.mmss) and Gons-400 decimal degree circle (dd.dddd). This setting applies to the angles in the spreadsheet editor as well as the angle format for reports.

**Vertical:** The options contained in this menu allow for specifying the type of vertical measurement information you will input or is contained in the rw5 file. The Vertical Angle selection assumes the barrel or scope of the instrument is level when reading 0 (zero). With this setting, the vertical component of a measurement record will have a header of VertAng. The Zenith Angle selection, most commonly used, assumes the barrel/scope to be level when reading 90. Using this setting results in a header of ZenithAng. Elevation difference displays the elevation difference between the occupied and foresight points. If the Distance option is specified as Slope, this elevation difference will be used to calculate the horizontal distance of the measurement. The header for this record is ElevDiff. The None selection assumes all distances are horizontal distances and removes the vertical component for a measurement from the editor. Switching modes can be performed at any time.

**Distance:** This option controls the display of either Slope or Horizontal Distances. Changing the display results in the distance data adjusting to reflect the correct value for the selection made. The Vertical data, VertAng, ZenithAng or VertDiff, is used to convert the distance value when changing this display option.

**Graphics:** The Raw Data Editor uses an optional graphics window to display the points and traverse lines in real time. As data is entered or edited, the graphics window will be updated to show the configuration or new configuration of the traverse. The option of whether to show sideshots is also available. When a cell is selected, the traverse or sideshot line in the display window will change to the color yellow for a graphical reference. The graphics window is toggled on or off from the Display — Graphics Window menu inside the raw file editor.
Graphics > On: Turns the graphics window on.

Graphics > Off: Turns the graphics window off.

Graphics > Show Sideshots: Controls the display of the sideshot data in the graphics window. Figure 1 shows the graphics window with sideshots on. Figure 1A shows the graphics window with sideshots off.

Figure 1 Sideshots On
**Graphics > Zoom Mode:** Within the graphics window, real time zoom is available. To zoom in press and hold the left mouse button and drag in the direction of the + symbol. To zoom out, press and hold the left button and drag in the direction of the - symbol.

**Graphics > Pan Mode:** Real time pan is available within the graphics window. To pan, set the graphics window to pan mode, then press and hold the left mouse button and then drag to desired position.

**Graphics > Resize Text:** With the this option on the text becomes smaller/larger in the view when you zoom in/out.

**Graphics > Fixed Text Size:** With this option on, the text stays a fixed size while zooming in and out.

**Spreadsheet Colors:** This option allows for the assignment of colors to record types. To change/define the color for a particular record, select Spreadsheet Colors from the Display pulldown within the raw editor. From the Color Settings dialog select the record to edit by clicking on the select button next to the desired record.
The color slide beside the select button shows the current setting for the record. After selecting the record, the Select Color dialog box will be displayed. Select the Set button next to the desired color for the record.

Display > Hide Row: This option allows for hiding single or multiple rows. This could be used to prevent crucial information from being accidentally altered during editing of data or data entry. Hiding a record does not exclude it from processing. To hide a record click on the row number at the far left of the editor. The entire row of data will highlight, now select the Hide Row option. Multiple rows or data can be selected by selecting the first row of data to hide then while holding down the shift key on the keyboard, select the last row to hide. All rows in between these two selections will be highlighted, now select Hide Row. When a row or rows of data are hidden, the row numbers will reflect the hidden rows. For example, Figure 2 below shows a multiple selection of rows 10-17 to hide. Figure 2A shows the editor with the rows hidden. Notice that the row numbers indicate hidden rows by showing a gap from rows 9-18.
Show Row: This option shows rows that have been hidden. To show hidden rows, the row above the first hidden row and the row below the last hidden row must be selected by using the shift key selection method described in Hide Row above. After selecting the appropriate rows, select the Show Row option. Figure 2B shows the selection of rows 9 & 18 in order to show the hidden rows 10-17. Figure 2C shows the editor after the Show Row option has been selected.
Hide By Point Numbers: This function prompts for a range of point numbers and then isolates records containing those point numbers by hiding all other records. This feature is useful to focus on certain point numbers in a large file.

Hide Selected Rows: This function hides the rows that are currently highlighted. To highlight multiple rows, pick in a cell with the mouse and then hold the Shift key while picking a cell on another row.

Show Selected Rows: This function unhides rows previously hidden by the Hide Selected Rows function.

Show All Rows: This function unhides rows previously hidden by the Hide Selected Rows or Hide By Point Numbers functions.

Hide Description Records: This option controls the visibility of the Description records contained in a rw5 file. The description record is an additional note used to store useful information in addition to typical point data. Sometimes these records clutter the raw file and make it hard to review actual survey data. The ability to control the description record visibility is a useful tool when reviewing survey data.
Show Description Records: This option shows (unhides) description records contained in the rw5 file.

Hide Record Headers: This option hides the in-line headers such as the PntNo, OcPt, FsPt, etc. The editor contains “Smart Headers” that changes with the type of data that is in the active row. These headers are not in-line and are always displayed at the top of the editor. Figure 2D shows the editor with the record headers hidden and the Smart Header active. Row #21 contains the active cell, the automatic header at the top of the editor shows traverse (TR) record headers.

Add Menu

Traverse: Adds a traverse record (TR) to the spreadsheet editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

SideShot: Adds a sideshot record (SS) to the spreadsheet editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.
**Backsight:** Adds a backsight (BK) to the spreadsheet editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Instrument Height:** Adds an instrument height (HI) record to the editor. This record contains both the instrument and rod height setting.

**Point:** Adds a point (PT) record to the editor. Provides options to either add a Blank Point Record or Import From Coordinate File.

Inserting a blank record allows for manual input to define the coordinates for the point. Import From Coordinate File imports the coordinate values from an existing point or range of points contained in the coordinate file. Enter the point number or range of points and select OK. The points will be read into the rw5 file at the top of the file.

**COGO Command:** Adds COGO Command (CC) record with a field to specify the command (Translate, Rotate, Scale or Align) and a field for entering the parameters. The COGO commands are executed in sequence as the rw5 file is processed from top to bottom by any of the process methods in the Process menu. The COGO commands are all transformation commands that are applied to the points in the current coordinate file. The following list is the syntax of the COGO commands:

- **Translate:** Range Dx Dy Dz Process_Zero_Z
- **Rotate:** Range Angle Base_Y Base_X
- **Scale:** Range Scale Base_Y Base_X Use_Z
- **Align:** Range From1 To1 From2 To2

All the parameters are entered into one spreadsheet cell next to the COGO function. The parameters use space separators. The following list is the parameter definitions:

- **Range:** point numbers
- **Dx:** delta easting (X)
- **Dy:** delta northing (Y)
- **Dz:** delta elevation (Z)
- **Process_Zero_Z:** toggle for whether to process points with elevation of zero (0=No, 1=Yes)
- **Angle:** rotation angle in dd.mmss format
- **Base_Y:** base point northing
- **Base_X:** base point easting
- **Scale:** scale factor
- **Use_Z:** toggle for whether to scale the elevations (0=No, 1=Yes)
- **From1:** point number of first source point
- **To1:** point number of first destination point
- **From2:** point number of second source point
For example, to translate points 1-10 by a delta Z of 6.0 while filtering out zero elevation points, set the parameters for the COGO Translate record as "1-10 0 0 6.0 0".

**Elevation:** Adds an elevation (EL) record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Note:** Adds a note (DS) record to the editor. Note records are for information display and do not effect processing except for two special notes which are:

- Elevation: 2D
- Elevation: 3D

These special notes set the elevation mode for processing for the records that follow the note. The raw editor starts in 3D mode. The "Elevation: 2D" note will switch processing to 2D mode and the "Elevation: 3D" note will switch the mode back to 3D. In 2D mode, the processing will not set the elevations in the coordinate file.

**Data On/Off:** Adds a data on/off (DO) record to the editor. This record toggles the raw data between processing on and off modes. The raw data starts in processing on mode. Working from top to down, when a DO record is reached, the processing mode is turned off. Then next DO record will turn processing back on, and so on. Data records that are in processing off mode and skipped when running the routines in the Process menu.

**Traverse Name:** Adds a traverse name (Name) to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**GPS:** Adds a GPS record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Reference Azimuth:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Control Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Setup Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Measurement Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Process (Compute Pts) Menu**

This menu contains tools to process raw data by various methods. The calculated coordinates, and notes if specified, are stored to the active specified coordinate file. The coordinate file can be specified using Set Coordinate File, under the Points pulldown within the drawing screen, or from the Tools menu of the editor, discussed later in this section. The options for processing are specified within either the Process Options dialog box or the Closure Options dialog box, depending upon . This dialog box is displayed before processing data, using any of the available methods, with the exception being the Least Squares method.
Multiple Measurements To Same Point: This option sets the method of how to handle multiple measurements to the same point. There are three available options, Use Last, Average or Use First. Use last uses the last measurement to calculate the position of the point. Average uses the average of all the measurements for the position calculation and Use Last takes the last measurement to the point as the data to use.

Use Backsight Reciprocals: The Backsight Reciprocal options treat reciprocal measurements "special". A foresight to point 15 from a setup on 14, followed by a backsight from 15 to 14, makes a pair of "reciprocal" measurements. The backsight "reciprocal" measurement can be ignored for its impact on recalculating the occupied point (None Option), or the elevation of component of the reciprocal measurements can be averaged (Average Elevation option), or both the elevation and distance can be averaged (Average Elev & Dist) to recalculate the setup (occupied point) coordinates.

Calculate Elevations: This option determines whether the elevations of the points will be calculated and written to the coordinate file. Options of whether to calculate All elevations or just the Sideshots Only are provided.

Direct-Reverse Vertical Angles: Specify whether to balance all or process the direct-reverse shots and use only the foresight direct shot.
**Report Angle Format:** Specifies the angle format for the report. The By File option makes the report use the angle format in the raw data (.RW5) file.

**Calculate Elevations:** This option controls which point elevations will be calculated. For example, if the traverse point elevations have already been adjusted and you need to recalculate the sideshot elevations, then use the SideShots Only option.

**Report SideShots:** Specify whether to include the sideshot data in the process results report.

**Point Protect:** This option will check the coordinate (.CRD) file for existing point data before processing. If the foresight point number for any traverse or sideshot record already is a stored coordinate in the coordinate (.CRD) file, then the program shows a list of conflicting point numbers. You can either continue processing and overwrite the coordinate (.CRD) file coordinates with the calculated raw file coordinates or cancel the processing to go back to the editor to change foresight numbers.

A report of the conflicting point numbers can be generated to the standard report viewer in Carlson by selecting the Report option on the Point Protect dialog box. From the report viewer, the report can then be printed, sent to the screen or saved to a file.
Create Point Notes: This option will generate a note (.NOT) file named after the coordinate file. The note file contains additional descriptions for points. With this option active, the text from all note records (DS records) will be stored to the note file for the foresight point number preceding the note records.

Calculate Grid Scale Factor at Each Setup: This option will calculate a scale factor for each TR and SS record. This scale factor is calculated as the average of the scale factors at the occupied and foresights points. At these points the scale factor is calculated as the projection grid factor multiplied by the elevation factor which is the earth radius divided by the elevation plus the earth radius \[SF = \text{Grid Factor} \times \left(\frac{\text{Earth Radius}}{\text{Elevation} + \text{Earth Radius}}\right)\]. In order to calculate these projection grid factors, the traverse coordinates must be in grid coordinates. When this option is selected, the program will prompt for the projection and zone to use. The elevation for the scale factor can be adjusted by the geoid height using the geoid specified in the Geoid To Apply list. The geoid height is added to the point elevation to adjust the elevation value used in the scale factor equation. The geoid surface files are not installed by default due to the large size of these files. To install the geoids to use with this option, go to the Carlson Software webpage and download the Geoid Grid Files from the Support->Downloads section.

Report Each State Plane Scale: This option becomes available if the Calculate State Plane Factor at Each Setup has been selected. With this option on, the scale factor at each point will be shown in the process results report.

Scale Factor: This value is multiplied by the horizontal distance for the traverse and sideshot records. This factor can be used to transform from ground to grid coordinates. This factor does not affect elevations.

Correct for Earth Curvature: This option adjusts the calculated points for the effect of the Earth's curvature. Typically this adjustment is small and adjusts the elevation more than the horizontal.

Report Angle Format: This option controls the angle format displayed on the process result report. The option of By Raw File will display the angles in the format that is contained in the raw file. The Bearing option will display the angle in a bearing format. The Azimuth option will display the azimuth of the measurement and the Angle Right option will display the angle right measurement of the observation.

Decimal Places for Report: This option controls the number of decimal places for the reported data.

Report Closure: This option determines whether the closure report will be displayed after processing. If processing a topo survey where the traverse has not been closed, then turn this toggle off for quick processing.
Report Sideshots: Controls whether the sideshot data is shown on the process report.

Reference Closing Point: This is an optional field for entering the coordinates to compare the ending traverse point with. This reference closing point is used to calculate the closure. Without using this option the program will by default use the starting coordinate as the reference closing point.

Report Output: There are three report output options contained in the raw editor, the Standard Report Viewer, the Custom Report Formatter and the Tabular Report Viewer. Each is documented below.

The Standard Report Viewer is the default report viewer throughout the program. Any routine that generates a report has this option and the data contained in the report depends upon the routine executed. The report viewer is also a text editor. It allows for addition and deletion of text in order to customize the report for printing or for saving to a particular format for a file. Options to print, send to the screen in the drawing window as text or save to a file are available.

The Custom Report Formatter allows for customization of the process results by selecting the fields and the layout of the fields to display. The settings can be saved to a format name and recalled when needed. Options to Delete, Export and Import saved Formats are also available.
To create a report, select data from the Available list and then select the Add button. This will populate the Used field with the selected data. Standard window selection methods can be used when selecting the data to report. Holding the ctrl key while selecting data allows for making random selections. Holding the shift key while selecting data will select the first item picked, last item picked and all items between.

The **Tabular Report Viewer** displays a report viewer consisting of tabs. Each tab organizes and displays different data depending upon the process option chosen. The process results using the No Adjust method results in three tabs the Report Header, Unadjusted Data and the Store Points tabs. Each of these tabs display different information which corresponds to the tab title. Using an adjustment method results in five tabs. In addition to the three listed above, an Angle Balance and Compass Closure tab is added. From the Tabular Report Viewer, the Standard Report Viewer can be switched to by pressing the Report option at the bottom of the dialog. This is useful when wanting to combine all tabs into one report for printing or saving to a file. An example of a Tabular Report for a compass rule adjustment is shown below.
Processing Methods

No Adjust: No Adjust means that no angle balance or traverse adjustment will be applied. Options are specified in the Process Options dialog. After picking OK for the process options dialog, a Traverse Points dialog appears for entering the starting and ending point numbers.

The program reads the raw file to set the defaults for these point numbers which are used to calculate the closure. The difference between the ending point and the reference closing point is the closure error and the sum of the traverse distances from the starting to the ending point is used as the total distance traversed. After picking OK for the second dialog, the program starts processing the raw file from the top record down. The result is displayed in the Standard Report Viewer which can save, print or draw the report.

Angle Balance: This process method applies an angle balance to the traverse lines when calculating the coordinates. The angle balance takes the angular error divided by the number of traverse lines and adjusts the angle of each traverse line by this amount. The angular error is the difference between the angle balance shot and a reference angle. The angle balance shot is specified as a type AB or CL+AB record in the raw file. If no AB record is found in the raw file, then the program will prompt for which traverse shot to use as the angle balance shot. The angle from the angle balance shot is calculated as the angle from the occupied point to the foresight point. The reference angle can be specified as a bearing, azimuth or by two point numbers in the dialog shown.
The angle balance report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted points and then the adjusted closure. Typically but not always, applying the angle balance correction will improve the traverse closure.

**Compass, Crandall, Transit:** These process methods apply the selected rule to the traverse lines when calculating the coordinates. After adjusting the traverse, the sideshots are also recalculated. The closure error is calculated as the difference between the closing shot and a reference point. The closing shot is specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file, then the program will prompt for which traverse shot to use as the closing shot. The foresight point is used as the closing coordinate. The reference point can be specified by point number or by entering the northing, easting and elevation. The process results report shows the unadjusted points, closure error, adjustments to each traverse point and adjusted point.

**Prepare Least Squares Data:** From the raw file data, this routine makes initial calculations for the coordinate points in the traverse.

This data, along with the control point coordinates and the angle and distance measurements, is stored to a data file with the same name as the current RW5 file except with a .LSQ extension (ie: survey.lsq goes with survey.rw5). The constraints of the routine are:

- All angle readings must be in angle right mode.
- The coordinates of the starting and the ending points must be known.

The routine begins with a dialog for specifying the reference closing coordinates and any scale factors to apply to the distance measurements. The Reference Closing Point is the last point in the traverse, whose coordinates must be
known. If an angle balance shot is used in the traverse, the Reference Angle Balance Angle must also be specified, either as a value or as the angle between known points.

Since angles and distances have errors of different magnitudes, they are normalized using weights, based on the accuracy and confidence with which these quantities have been measured. There is a dialog for specifying the estimated measurement errors. The Reading Error is the horizontal angular error in the instrument. For example, for a "5-second" instrument this error would be 5. The Pointing Error accounts for several factors in the horizontal angle reading including accuracy lining up the crosshairs on the target, the target size and the optical quality of the instrument. The Target and Instrument Centering Errors are the distance off the point due to faulty centering. The EDM Constant Error is the accuracy of the instrument distance measurements. The EDM Scaler Error is entered in parts per million for the increased error in longer measurements. These settings can be saved and loaded as a way to store settings for different equipment.

The program will calculate the weights for each distance and angle measurement using these measurement errors. The control points, points to adjust, distance and angle measurements with weights are reported. You can edit these measurements and weights using the Edit Least-Squares Data routine or go directly to the Process Least-Squares Data routine.

**Edit Least Squares Data:** This routine edits the points, measurements and weights stored in the .LSQ file associated with the current RW5 file. The editor works through the dialog shown. You can edit, add or remove the control points, adjust points, angle measurements or distance measurements. The program does not check that the editing is valid. So you need to make sure that your changes keep a good set of least-squares data (i.e. don't delete a needed control point). The Distance Error button allows you to set the distance standard error weights for all the distance measurements to the same value. Likewise the Angle Error button sets the standard error weights for all the angle measurements.
Least-Squares Input Data:

Control Points
Point# Northing Easting
1 5000.000 5000.000
8 5000.000 5000.000

Distance Observations
Occupy FSight Distance StdErr
1 2 711.409 0.018
2 3 457.745 0.017
3 4 201.295 0.017
4 5 497.024 0.018
5 6 223.972 0.017
6 7 233.872 0.017
7 8 387.073 0.017

Angle Observations
BSight Occupy FSight Angle StdErr
1 2 268d53'30'' 15.1844''
2 3 262d54'48'' 13.6826''
3 4 208d57'10'' 30.3633''

Process Least Squares Data
This routine applies a least-squares adjustment to the data stored in the .LSQ associated with the current raw data (.RW5) file. The closing errors are distributed among the other points, using the "Method of Least Squares" (Ref: Wolf, P.R. and Ghilani, C.D., 1996, "Adjustment Computations", John Wiley and Sons, NY, Third Edition). After the adjustment, the rest of the raw file is processed to recalculate the sideshots. There is an option to draw standard error ellipses around the adjusted points. The ellipse axes are multiplied by Ellipse Scale Factor to make the ellipse larger for easier viewing.
The least-squares process report shows the input data and the results. For each point, the amount adjusted and the standard error in X and Y are reported. The Reference Standard Deviation is based on the sum of the residuals and the initial estimated standard errors. The Chi-Squares test is a goodness-of-fit test that checks the reference standard deviation with the least-squares model. If this test fails, there may be a blunder in the measurement data or the initial estimated standard errors were too low or too high.

**Stadia Processing Method**: Provides functionality to process Stadia surveying notes. Stadia sighting depends on two horizontal cross-hairs, known as stadia hairs, within the telescope. These hairs are parallel to the horizontal cross-hair and are equally spaced above and below it. The distance between the two stadia hairs is known as the intercept. The distance from the instrument to the rod is 100 times the intercept. For example, an intercept of 3.10 would represent a distance of 310 (3.10 X 100). For entering in stadia notes, you would enter the horizontal angle, the distance (entered as the intercept X 100) and the vertical angle.

**GPS**: The process GPS routine allows for reduction of GPS records that reside in a raw (*.RW5) file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates. When selected, the GPS Settings dialog will appear as shown below.

**GPS Settings**

- **Projection Type**: State Plane 83
- **Zone**: KY Single Zone
- **User System**: Define Projection
- **Use Alignment File For Localization**
- **Transformation**: Plane Similarity
- **One Point Align Method**: State Plane Grid
- **Two Point Align Method**: Fit & Rotate
- **Project Scale Factor**: 1.000000000
- **Geoid To Apply**: USA (Geoid99)
- **Decimal Places for Report**: 0.000
- **Units**: US Feet
- **Multiple Measurements To Same Point**: Use Last

**GPS > Projection Type**:
Defines the datum coordinate system to be used for converting the latitude, Longitude and WGS84 Ellipsoid height...
collected from the GPS receiver into Cartesian coordinates. The supported projection types are State Plane 83, State Plane 27, UTM, Lat/Long, Great Britain-OSGB36, Australia, New Zealand-NZGD2000, New Zealand-NZGD49, and France NTF-GR3DF97A. A User-Defined option is also available for defining a user projection.

The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and )SGM02 (Britain). GeoUser-Defined projections are supported. To define a new projection select the Define Projection option. This will bring up the following dialog.

Enter a name for your system (e.g. PRVI for Puerto Rico/Virgin Islands), then select a Projection type and enter the appropriate parameters. Note that all latitude and longitude values are in Degrees Minutes and Seconds (dd.mmss) and False Northing and False Eastings are always presented in meters. Define a Datum shift by selecting the Select Datum radial button. You may select a predefined Ellipsoid or set your own parameters by typing in a new ellipsoid name in the Ellipsoid field and entering values for a and 1/f. When you enter in a new Ellipsoid name, the Datum name field will be blank. The values for Dx, Dy, Dz, Rx, Ry, and Rz and scale are "to WGS84". If the values you have are "from WGS84", simply reverse the sign of each value (positive becomes negative and vice versa).

You may save your system to a "udp" file. To Load a user defined coordinate system from a file, select the Load radial button. A list of user defined systems will be displayed. Select the desired system and press OK.

GPS>Zone: for State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

GPS>Use Alignment File For Localization: With this option toggle on, a prompt for the Alignment File to Process will be displayed. This file is typically created by SurvCE (Carlson's Data Collection System) using the Localization routine or by Carlson Field Using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.crd) file and a report will be presented in the Carlson editor for saving or printing purposes.
**GPS>Transformation:** The transformation in the align Local Coordinates command can either be by plane similarity or rigid body methods. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale. The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates or the Localization routine in SurvCE.

**GPS>One Point Alignment Azimuth:** This option applies to the rotation when using one point in Align Local Coordinates or the Localization routine in SurvCE. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

**GPS>Two Point Alignment Method:** There are two options when using this method, Fit & Rotate and Rotate Only. Fit & Rotate will use the second point in the localization file for direction and scaling. The Rotate Only option allows you to use the second point in the localization file for direction but not for scaling. When using the Rotate Only option, any scale factor entered in the Project Scale Factor will be used.

**GPS>Project Scale Factor:** For most applications, the Scale Factor should be set to 1.0. The scale factor represents the "combined" grid/elevation factor that reduces ground distances to grid. After converting the LAT/LONG from the GPS records to state plane coordinates and applying the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X, Y, and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction of the coordinate for the adjusted distance. The base point is the first point in the alignment (Localization) file. If there are no points specified in the alignment file, then 0.0 is used as the base point. If using an alignment file (Localization File) this value will be automatically calculated and displayed. Manual entry of a scale factor is also permitted and is often used with the Two Point Alignment Method when a scale factor is known.

**GPS>Geoid to Apply:** The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain).

This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the national Geodetic survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (E0), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This correction is the geoid undulation (Ug). The formula is \( He = E0 + Ug \).

Carlson applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a known point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson can model the elevation difference which can generally pick up the local Geoid undulation.

**GPS>Units:** Coordinates can be reduced into one of three available units, Metric, US Feet or International Feet.

**Process>Process Settings:** This option allows for the setting of user preferences and tolerances to be used during processing and generation of reports.
Multiple Measurement Settings: These options provide control for managing how multiple measurements to the same point are handled and reported.

Distance Tolerance Horizontal and Vertical: Allows for user input of desired tolerance values for multiple measurements. Exceeded tolerances will be displayed on the process results report. With the Report Residuals option ON, the residual values of the measurements will be shown on the process results report. The data to be averaged can be either the Distance Measurements or the Coordinates.

Backsight Orientation Settings: This option will take multiple backsight measurements for an occupation and computes a least squares orientation for the instrument. There is also an option to compute and correct for the instrumental collimation error from the available measurements if both direct and reverse readings to one or more stations in the same set have been recorded. The program uses the BD (backsight direct) and BR (backsight reverse) records to identify the measurements to process. You can backsight different targets. The targets do need to have known coordinates either as points in the current coordinate file or as SP records in the raw file. The measurements can be complete with angles and distance, and they can be partial with only angles or only distance. When this option is active, the calculated backsight orientation will override the SetAzi field in the BK (backsight) record for the setup. The process report will include all the measurements used, the residuals and the resulting backsight orientation. The least-squares routine will also calculate the occupied station coordinate by resection if possible from the measurements and the report includes this calculated position along with the reference position and residuals. This calculation of the occupy point is used only for a check for the report and does not effect the occupy coordinate for processing. Note that if the occupied station position is unknown, there must be sufficient measurements to at least three known reference stations to support the resection and orientation solution. Here is an example of the raw data and the report.

Raw Data

<table>
<thead>
<tr>
<th>PntNo</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>71</td>
<td>4998.1900</td>
<td>5199.8200</td>
<td>125.0000</td>
<td>PK</td>
</tr>
<tr>
<td>22</td>
<td>4770.1200</td>
<td>5192.5000</td>
<td>90.0000</td>
<td>PK</td>
</tr>
<tr>
<td>2</td>
<td>4900.2700</td>
<td>5007.3100</td>
<td>75.0000</td>
<td>PK</td>
</tr>
<tr>
<td>53</td>
<td>5345.8600</td>
<td>4799.0400</td>
<td>150.0000</td>
<td>PK</td>
</tr>
<tr>
<td>1</td>
<td>5000.0000</td>
<td>5000.0000</td>
<td>100.0000</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OcPt</td>
<td>BaPt</td>
<td>Azi</td>
<td>SetAzi</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0°00'00'''</td>
<td>0°00'00'''</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OcPt</td>
<td>FsPt</td>
<td>HorzAngle</td>
<td>SlopeDist</td>
<td>ZenithAng</td>
</tr>
</tbody>
</table>
Check Point Settings: These options provide user controls for survey check points. With Report Check Points ON, any point coded as a check point in the raw data file, will be reported. When selected the Check Point Code and Distance Tolerance fields become active and allow for editing. The Check Point Code is a user specified code entered in during the survey that tells the program to check the coordinates of a particular point with the coordinates of another point. This code is configurable by the user. An example of a point description coded as a Check Point would be as such, "trav =8". This description tells the program that the description of the point is "trav" and to check the coordinates of the this point with that of point #8. The Distance Tolerance Horizontal and Vertical are user...
specified tolerances for the check point. If either of these tolerances is exceeded it will be reported on the process results report.

**Instrument/Rod Height Ranges:** These settings are used to check the instrument and rod heights when the raw file is processed. The program will report warnings if there are any heights that exceed the specified min/max ranges.

**Angle Only Measurements:** The Combine Elevations Method applies to points calculated from Angle Only measurements. Angle Only points are calculated as part of the processing for the No Adjust, Compass, Crandall, Transit and Angle Balance process methods. To calculate points from Angle Only measurements, there needs to be multiple SS records with horizontal and vertical angles and no distance with the same target foresight point number from setups at different occupy points. The elevations can be set as the average from the multiple measurements, using the highest measured elevation, or using the lowest measured elevation. For example, to survey the top of a tree, you could have a SS to foresight point 99 from occupy point 1 with a horizontal and vertical angle and another SS to foresight point 99 from occupy point 2 with a horizontal and vertical angle. Then point 99 can be calculated by angle-angle intersect which determines the horizontal distances from 99 back to occupy points 1 and 2. These distances are then used with the vertical angles and occupy point elevation to calculate the elevation at point 99.

**Store Point Records:** These options control how any store point (PT) record is handled during processing of the raw data file. There are three options for storing Store Point (PT) records, *Never, Always, and When CRD Empty*. *Never* prevents any Store Point (PT) Record Report in the raw file from being written to the crd file. With this option on no existing point in the crd file would be overwritten. *Always* will write to the coordinate file and will overwrite any existing point with the same number of the Store Point (PT) records. The *When CRD Empty* option will only write Store Point (PT) records to the coordinate file when it is empty. *Report Store Points* displays all store points in the process results report. The *Hold Store Points* option will hold the coordinate values for the store point record when measurements are taken to the store points. This will prevent the coordinates of the point from changing if measurements to the point dictate a change in coordinate position.

**Direct-Reverse Settings:**

**Direct-Reverse Vertical Angles:** This option determines how to handle direct-reverse vertical angle measurements when processing. *Balance Direct-Reverse* will take the mean of the direct-reverse measurements and use this value when processing the file. *Direct Only* will only use the direct measurement to the point for processing.

**Foresight-Backsight Measurements:** Balance Foresight-Backsight allows for averaging in the Foresight and backsight measurements when using direct-reverse sets. The Foresight Only option will average the foresight measurements only of a direct-reverse set.

**Horizontal Angle Tolerance (Seconds):** This is the tolerance that the angle measured by the direct measurements and the angle measured by the reverse measurements in a direct-reverse set must fall within.

**Flip Angle Tolerance (Seconds):** User specified value for the acceptable difference in measured horizontal angles determined from the direct (BD-FD) and reverse (BR-FR) observations.

**Distance Tolerance:** User specified tolerance for the difference in distance measurements to the same points. When this value is exceeded on a measurement, it will be displayed on the process results report.

**Measurements To Control Points:** The *Store To Current Coordinate File* option applies when a control coordinate file is used in addition to the active coordinate file. When processing the raw file, measurements to point numbers that are in the control coordinate file will not be stored into the active coordinate file when this option is on.
**Drawing Points and Linework:** This option controls the drawing of points and linework using Field to Finish. It differs from the draw traverse and sideshot lines under the Tools Menu of the Raw Editor by using a field to finish code table (*.fld) to define how the points and linework are to be drawn and layerized. There are three settings for this option, Manual, Auto and Prompt. Manual means that the file will not be processed using the field to finish codes and no points or linework will be drawn upon exiting the raw editor. The Auto option will use the current or last used field to finish file (*.fld) to draw the points and lines on the drawing screen when the raw editor is existed. The option of Prompt will give the option to draw the points and lines to the screen. With this setting specified, the following prompt will be displayed when exiting the editor.

![Field To Finish](image)

**Tools Menu**

![Tools Menu](image)

**Direct-Reverse Report:** This routine creates a report of direct and reverse shots along with the resulting averaged shots. Any tolerance specified in the Process Settings>Direct-Reverse Settings section, that is exceeded will be displayed in this report. The residuals are the difference between the measurement and the final average. If the current spreadsheet display mode for distances is set to horizontal, then the report will show horizontal distances. Otherwise, the report uses slope distances.

**Reduce Direct-Reverse:** This routine processes the direct and reverse shots and simplifies the raw file by replacing the sets of direct and reverse shots with the resulting average traverse record.

**Update Raw from Points:** This routine is used to update the raw data based upon the coordinates of the points contained in the coordinate (*.crd) file. For example if the raw data has been processed using the compass rule adjustment method, the points in the crd file are now adjusted. However the raw data remains unchanged. If a record of the rw5 file reflecting the angles and distances between the points after an adjustment has been ran is desired, this routine can be run thus updating the raw data to reflect the adjusted angles and distances. Another application for this routine is that of building a rw5 file for future processing and adjustment. For example if a point file or text file has been received from another engineering firm or fellow surveyor and you would like to build a rw5 file for future reference and processing this option can also be used to accomplish this. The rw5 file would be set up with the occupied points, foresight points and the desired angle type to use specified for the traverse. This would be all the manual entry of the data necessary. After creating the "shell" of the traverse then run the update raw from points routine and the raw data, as contained in the coordinate file, will be imported into the rw5 file thus filling out the horizontal angle, distance and vertical components specified.
**Find Bad Angle:** This routine applies the angular error to each traverse record one at a time. The adjusted traverse record that improves the closure the most is reported as the Bad Angle. The angular error is the difference between the angle balance shot and a reference angle.

**Append Another Raw File:** This routine prompts for another raw data (.RW5) file which is read and the data added to the end of the existing raw data (.RW5) file. For example, if you are editing the raw file from the first days work and have a separate raw file with a second days work, you can use this routine to add the second raw data to the first raw file.

**Draw Traverse-Sideshot Lines:** This routine draws lines for all the traverse and sideshot records. Sideshot Traverses are traverses that do not lead to the closing or ending point. There are different layers so that the lines can be drawn with different colors. This command does not process the raw file. Instead it reads the raw file and for each traverse and sideshot record, the program looks up the coordinates for the occupied and foresight points in the CRD file. So it may be necessary to run Process>No Adjust before running this routine. With the Erase Previous Traverse-Sideshot Lines toggled on, any previous linework drawn using this method will be erased from the drawing screen before drawing the lines again.

**Renumber Points:** This routine renumbers points in the raw file. This applies to all point numbers including: TR, SS, and PT records.

**Range of Points to Renumber:** Enter in the range of points to change, ie 1-4.

**Line Number to Begin Renumbering:** This corresponds to the line number located at the far left of the raw data editor. Enter the line number to begin the renumbering.

**Line Number To End Renumbering:** This also corresponds to the line number located at the far left on the raw data editor. Enter the line number to end the renumbering. If the range of numbers specified does not occur between the beginning line number and the ending line number, no changes will be made.

**Numbers to Add to Point Numbers:** Enter in the value to add. This number will be added to the existing point number to create the new point number. For example, if the number to add is 10 and the existing point numbers 1 and 6, the new renumber points will be 11 and 16.

**Point Groups:** This option can be used to organize the survey data into point groups. There are three options for the creation of point groups, Create All Point Group, Create Traverse Point Group and Create
Sideshot Point Group. The Create All Point Group option, creates a user specified group containing all of the points defined in the rw5 file. Create Traverse Point Group creates a user specified group containing only the points defined in the traverse records (TR) of the rw5 file. The Create Sideshot Point Group creates a user specified group that contains only the points defined in the sideshot records (SS) of the rw5 file.

Format of the raw data (.RW5) file

The Carlson raw data format is a comma delimited ASCII file containing record types, headers, recorded data and comments. The format is based on the RW5 raw data specification, with the exception of angle sets. Angle sets are recorded as BD, BR, FD and FR records to allow reduction of all possible combinations. Essentially, these records are identical to a sideshot record.

Backsight Record
Record type: BK
Field headers:
OP Occupy Point
BP Back Point
BS Backsight
BC Back Circle
Sample(s):
BK,OP1,BP2,BS315.0000,BC0.0044

Line of Sight Record
Record type: LS
Field headers:
HI Height of Instrument
HR Height of Rod*  
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
LS,HI5.000000,HR6.000000
LS,HR4.000000

Occupy Record
Record type: OC
Field headers:
OP Point Name
N Northing (the header is N space)
E Easting (the header is E space)
EL Elevation
– Note
Sample(s):
OC,OP1,N 5000.00000,E 5000.00000,EL100.000,–CP

Store Point Record
Record type: SP
Field headers:
PN Point Name
N Northing
E Easting
EL Elevation
– Note
Sample(s):
SP,PN100,N 5002.0000,E 5000.0000,EL100.0000,–PP

Traverse / Sideshot Record / Backsight Direct / Backsight Reverse / Foresight Direct / Foresight Re-
Record type: TR / SS / BD / BR / FD / FR

Field headers:
OP Occupy Point
FP Foresight Point
(one of the following)
AZ Azimuth
BR Bearing
AR Angle-Right
AL Angle-Left
DR Deflection-Right
DL Deflection-Left
(one of the following)
ZE Zenith
VA Vertical angle
CE Change Elevation
(one of the following)
SD Slope Distance
HD Horizontal Distance
– Note
Sample(s):
TR,OP1,FP4,AR90.3333,ZE90.3333,SD25.550000,–CP
SS,OP1,FP2,AR0.0044,ZE86.0133,SD10.313750,–CP
BD,OP1,FP2,AR0.0055,ZE86.0126,SD10.320000,–CP
BR,OP1,FP2,AR180.0037,ZE273.5826,SD10.315000,–CP
FD,OP1,FP3,AR57.1630,ZE89.4305,SD7.393000,–CP
FR,OP1,FP3,AR237.1612,ZE270.1548,SD7.395000,–CP

GPS

Record type: GPS

Field headers:
PN Point Name
LA Latitude (WGS84)
LN Longitude (WGS84, negative for West)
EL Ellipsoid elevation in meters*
– Note
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample(s):
GPS,PN701,LA42.214630920,LN-71.081409184,EL-21.8459,–C

Alphabetical listing of Field Headers

AD Azimuth Direction ( 0 for North, 1 for South)
AL Angle-Left
AR Angle-Right
AZ Azimuth
BC Back Circle
BP Back Point
BR Bearing (this field will be recorded as N123.4500W)
BS Backsight (when back point is not defined)
CE Change Elevation
DL Deflection-Left
DR Deflection-Right
DT Local Date (MM-DD-YYYY)
E Easting (the header is E space)
EC Earth Curvature (0 for off, 1 for on)
EL Elevation (GPS value is ellipsoid elevation in meters)
EO EDM Offset
FE Foresight Elevation
FP Foresight Point
HD Horizontal Distance
HI Height of Instrument
HR Height of Rod
LA Latitude
LN Longitude
N Northing (the header is N space)
OC Occupy Point Coordinates
OP Occupy Point
PN Point Name
SD Slope Distance
SF Scale Factor
TM Local Time (HH:MM:SS)
UN Distance Unit (0 for feet, 1 for meter, 2 for US feet)
VA Vertical Angle
ZE Zenith
– Note

Traverse Examples
This first example is a closed traverse with an internal backsight of azimuth 178d0'42''

Use the functions under the Add menu to create and fill out the raw file as shown here.

Notice that the record from point 7 to 8 is set as a CL+AB record. This tells the program that point 8 is the closing point and that the angle from 7 to 8 is the closing angle. For traverse adjustment, the closing reference point is 1 and the closure error is the difference between point 1 and point 8. For angle balance, the reference closing angle is 358d0'42'' (178d0'42'' + 180). The angle balance error is the difference between this reference angle and the angle from points 7 to 8.
Now let's process using Compass adjustment with Angle Balance. Choose Compass under the Process menu and fill out the dialogs as shown.

First half of process report:

Process Results 05/23/2002 10:06
Raw file> c:/scadxml/data/example.rw5
CRD file> C:/scadxml/DATA/example.crd

Scale Factor: 1.00000000
Correct for Earth Curvature: OFF
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42"

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Angle</th>
<th>Slope</th>
<th>Inst</th>
<th>Rod</th>
<th>Northing</th>
<th>Easting</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5330</td>
<td>89.4050</td>
<td>711.32</td>
<td>5.32</td>
<td>6.00</td>
<td>5038.43</td>
<td>5710.27</td>
<td>103.29</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5448</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
<td>4587.89</td>
<td>5791.20</td>
<td>106.36</td>
</tr>
<tr>
<td>4</td>
<td>AR208.5710</td>
<td>89.1803</td>
<td>201.31</td>
<td>5.40</td>
<td>6.00</td>
<td>4397.30</td>
<td>5726.43</td>
<td>108.22</td>
</tr>
<tr>
<td>5</td>
<td>AR247.1657</td>
<td>88.5235</td>
<td>497.12</td>
<td>5.40</td>
<td>6.00</td>
<td>4363.08</td>
<td>5230.59</td>
<td>117.37</td>
</tr>
<tr>
<td>19</td>
<td>AR289.3456</td>
<td>91.4405</td>
<td>112.45</td>
<td>5.40</td>
<td>6.00</td>
<td>4471.32</td>
<td>5260.88</td>
<td>113.36</td>
</tr>
<tr>
<td>6</td>
<td>AR277.4835</td>
<td>90.2926</td>
<td>223.98</td>
<td>5.40</td>
<td>6.00</td>
<td>4586.54</td>
<td>5245.67</td>
<td>114.85</td>
</tr>
</tbody>
</table>

Chapter 3. Survey Module
Closure Results (Before Angle Balance)

Starting Point 1: N 5000.00 E 5000.00 Z 100.00

Closing Reference Point 1: N 5000.00 E 5000.00 Z 100.00

Ending Point 8: N 5000.09 E 4999.97 Z 100.06

Azimuth Error: 341°38'22''
North Error: 0.09061
East Error: -0.03007
Vertical Error: 0.05953
Hz Dist Error: 0.09547
Sl Dist Error: 0.11251

Remainder of process report:

Compass Closure

Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Original Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Adjusted Northing</th>
<th>Easting</th>
<th>Dist</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5038.445</td>
<td>5710.269</td>
<td>5038.440</td>
<td>5710.294</td>
<td>0.025</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>3</td>
<td>4587.914</td>
<td>5791.222</td>
<td>4587.907</td>
<td>5791.263</td>
<td>0.042</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>4</td>
<td>4397.319</td>
<td>5726.469</td>
<td>4397.310</td>
<td>5726.517</td>
<td>0.049</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>5</td>
<td>4363.044</td>
<td>5230.628</td>
<td>4363.032</td>
<td>5230.693</td>
<td>0.067</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>6</td>
<td>4586.509</td>
<td>5245.681</td>
<td>4586.496</td>
<td>5245.755</td>
<td>0.075</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>7</td>
<td>4613.178</td>
<td>5013.335</td>
<td>4613.163</td>
<td>5013.416</td>
<td>0.083</td>
<td>S 79°46'08'' E</td>
</tr>
<tr>
<td>8</td>
<td>5000.017</td>
<td>4999.905</td>
<td>5000.000</td>
<td>5000.000</td>
<td>0.097</td>
<td>S 79°46'08'' E</td>
</tr>
</tbody>
</table>

Max adjustment: 0.097
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

Point Horizontal Zenith Slope Inst Rod Northing Easting Elev
No. Angle Angle Dist HT HT Description

<table>
<thead>
<tr>
<th>No.</th>
<th>Original</th>
<th>Adjusted</th>
<th>Dist</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5326</td>
<td>89.4050</td>
<td>711.34</td>
<td>5.32</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5434</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
</tr>
<tr>
<td>4</td>
<td>AR208.5704</td>
<td>89.1803</td>
<td>201.30</td>
<td>5.40</td>
</tr>
<tr>
<td>5</td>
<td>AR247.1657</td>
<td>88.5235</td>
<td>497.09</td>
<td>5.40</td>
</tr>
<tr>
<td>6</td>
<td>AR289.3456</td>
<td>91.4405</td>
<td>112.47</td>
<td>5.40</td>
</tr>
<tr>
<td>7</td>
<td>AR277.4839</td>
<td>90.2926</td>
<td>223.99</td>
<td>5.40</td>
</tr>
<tr>
<td>8</td>
<td>AR92.4130</td>
<td>90.2746</td>
<td>233.88</td>
<td>5.40</td>
</tr>
</tbody>
</table>
Shown above is the resulting process report. The angle balance had an error of 39 seconds which was divided among the 7 traverse sides. The Compass Closure shows how each traverse point was adjusted and then the resulting adjusted angles and distances.

Here is another layout of the last example that shows an external backsight setup. In this case there are two known points. Point 1 is the starting point and point 21 is the initial backsight. The setup could also use a backsight azimuth (ie north azimuth for example) instead of a backsight point number.

The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.
Example of an open traverse

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.

The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Here is an example of an open traverse.

Compass Report from Open Traverse example:

Process Results
Raw file> d:/scdev/data/tsurvey.rw5
CRD file> d:/scdev/data/tsurvey.crd

Compass Closure
Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Original</th>
<th>Adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point# Northing Easting Northing Easting Distance Bearing</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>5013.76 5711.18 5013.78 5711.13 0.047</td>
</tr>
<tr>
<td>3</td>
<td>4560.69 5776.42 4560.72 5776.35 0.078</td>
</tr>
<tr>
<td>4</td>
<td>4372.46 5705.08 4372.50 5705.00 0.091</td>
</tr>
</tbody>
</table>

Point Horizontal Vertical Slope Inst Rod Northing Easting Elev
No. Angle Angle Dist HT HT
Description

| 2 | AR133.5324 89.4050 | 711.27 5.32 6.00 5013.78 5711.13 103.29 |
| 3 | AR262.5506 89.3236 | 457.74 5.43 6.00 4560.72 5776.35 106.36 |
| 4 | AR208.5712 89.1803 | 201.30 5.40 6.00 4372.50 5705.00 108.22 |

Chapter 3. Survey Module 392
The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.

---

### Portion of typical Sokkia/SDR raw data file:

00NMSDR20 V03-05 Jan-22-98 19:14 122211
10NMW970709A
13CPS Sea level crn: N
02TP0015000.000005000.000085.6350000.22000000PK-FD
08KI00035000.00005192.9200081.74500000MN-SET
07TP0001000390.00000000.00000000
09F10001000193.1000092.40416660.00000000MN-SET
09F100010100193.0000091.31388880.00000000SN-REC

### Portion of typical Wild/Leica raw data file:

410001+000000SB 42....+00000000 43....+00000000 44....+00000000 45....+00000000 110002+00000000
21.124+35959590 22.104+08748240 31...1+00000000 51..0.+0012+000 110003+00000000
21.124+00000000 22.104+08748240 31...1+00267075 51..0.+0012+000 110004+00000000
21.124+00420390 22.104+08702570 31...1+00168234 51..0.+0012+000 110005+00000000
21.124+26029130 22.104+09311370 31...1+00206133 51..0.+0012+000 110006+00000000
43....+00000000 44....+00000000 45....+00000000 110007+00000000 21.124+25827090 22.104+09504550
31...1+00106228 51..0.+0012+000 110008+00000000 21.124+27151500 22.104+09312240 31...1+00106066
51..0.+0012+000

### Portion of typical SMI raw data file:

CM Definitions: SS: Side Shot; TR: Traverse; OC: Occupied Coordinates; PC: Point Coordinates; CM: Comment; OS: Occupied Station; TS = time stamp; e = electronic; m = manual; CM TS TUE 04/09/91 09:41:25P
PC 1 5000.000000 5000.000000 0.00000
SS e HI:4.000 HR:5.000 PIPE/F
0 1 2 BAZ:0.000000 AR:0.000040 ZA:91.24330 SD:92.020
SS e HI:0.000 HR:0.000 BC/BR FRAME 1ST
0 1 3 BAZ:0.000000 AR:28.47220 ZA:91.20250 SD:65.240

### Portion of typical PC COGO raw data file:

---

Chapter 3. Survey Module 393
Portion of typical Nikon raw data file:
MP,NOR,,5000.0000,5000.0000,100.0000,1
ST,NOR,,1,5.0000,0.0000,0.0000
SS,1,5.0000,131.0605,91.3744,88.4935,10:36:15,CL1
SS,2,5.0000,137.6770,90.2923,88.5236,10:36:50,CL1

Portion of typical MDL/Laser raw data file:
D052097F04P52I494P01P02
H32473V-0639R016202P03
H06687V-0706R014936P91
H03840V-0483R017380

Portion of typical Geodimeter raw data file:
50=HAWTHORN
54=19398
23=3222
2=1
37=1000.00
38=5000.00
39=700.000

Portion of typical Survis raw data file:
_OCCUPY_PNT_
621 616 5.140
148.36076
10255015.7245 3790987.2398 87.6695 ir
1025535.8009 3790669.8100 100.3900 ir
_COMMENT_
Thu Apr 08 08:14:14 1999
_BACKSIGHT_
0.00000 90.33400 609.4200 11.900 ir
_SIDESHOT_
1 0 0
18.47550 90.55000 17.4200 5.300 TP: gps1

Portion of typical Fieldbook raw data file:
NE 32 10696.4141 10043.5613 "SN-SET"
AZ 32 27 0
STN 32
BS 27
AD 27 0.00000 NULL "SN-SET"
AD 33 183.23250 183.660 "SN-SET"

Portion of typical SurvCOGO raw data file:
19100 , 0 , 19101 , 5 , 5.25 , 4.7 , 35.15 , 550 , 91.23 , START
19101 , 19100 , 19102 , 5 , 5.15 , 4.7 , 35.15 , 120.23 , 88.34 ,
19102 , 19101 , 19103 , 5 , 5.2 , 4.7 , 125.1444 , 180.41 , 90 ,
19103 , 19102 , 19104 , 5 , 5.2 , 4.7 , 125.15 , 240.03 , 90 ,
19104 , 19103 , 19105 , 5 , 5.3 , 4.7 , 315.15 , 305.5 , 90 , IRON PIN
19105 , 19104 , 19106 , 5 , 5.4 , 4.7 , 215.15 , 140.35 , 90 , IRON PIN
Edit-Process Level Data

This command is for entering and calculating level data. It has a spreadsheet editor for entering the level measurements, and the level calculations are updated as the data is entered. There is also a processing and reporting feature.

Carlson Software supports two level file formats:

**LEV Files:** The .LEV file is the old format. You can still edit and process files in this format. The LEV format only supports differential levels, single and three-wire. The LEV file has 5 record types:

1) SR - Start Record. Contains the starting benchmark measurement.
2) TP - Turning point record, contains the backsight and foresight to the turning point.
3) LV - Side Shot (or level) record. Contains the foresight measurement to the point.
4) ER - End Record, contains the measurement to the ending benchmark.
5) Note/Comment - starts with two dashes

**TLV Files:** The TLV file format can contain Differential and/or Trig-Level data. This is Carlson’s new format and is supported by SurvCE (Carlson data collection program). The TLV file has the following record types:

1) H1 - First header record contains project information
2) H2 - Second header record contains date, time, temperature and pressure information
3) BM - Benchmark record, contains the point number, elevation and description of the benchmark.
4) LS - Rod height, only used with TRIG-LEVEL data.
5) BS- Backsight measurement. This record contains the backsight point number and measurement:
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
6) FS - Foresight measurement. This record contains the foresight point number and measurement.
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
7) Note/Comment - starts with two dashes

This routine runs the *.TLV / *.LEV file editor and file report functions.

**LEV File Editor:**
If you are creating a new .LEV file, you must choose either single-wire or three-wire for your level format data entry preference.

Three Wire leveling, or precise leveling, is a process of direct leveling wherein three cross hairs, or threads, are read and recorded rather than the single horizontal cross hair. Note below, in the sample three-wire editor graphic, the additional columns representing top and bottom readings.

The commands starts by asking you, with a dialog box, to select an existing level file (.LEV) to process or to select a name for a new level file. The below examples are using existing files. Once this choice is made the small, Level Format dialog appears.
Regardless of whether you choose Single or Three Wire, the Level Editor appears in its own window. Below we see the editor displaying the contents of two existing files of level information. One is single wire and the other is three wire. The pulldown menus are the same for both, as described below in detail.

In the spreadsheet, the background color of the cells indicate the data type. White cells are for user-specified values. Blue cells are program calculated values. Black cells are data fields that aren't used by the level record for that row.
Level File Editor - sample Three Wire data

File-Settings

File: Standard File routines - Open, Save, Save As, Settings, Print and Exit. Settings brings up a dialog where you can adjust the 3-wire tolerance and distance values. Open will allow you to open up another existing .LEV file.

File->Import: This routine imports Leica level data in .GSI or .XML format, TDS .RAW format, or Trimble .DAT format into the level editor.

Edit: Cut, Copy, Paste and Go To. Go To will take you to the row of your choosing.

Add: These options provide the standard level run routines. Details on each and a graphic of the pulldown follow.

Tools: This pulldown is for adjusting and storing elevations.

The Add and Tools pulldowns at the top of the editor provide the following features:

Level Start (SR): Starts the level run, usually with a know starting elevation or benchmark.

Level Turning Point (TP): Turning point procedure for leveling.

Level Side Shot (LV): For entering leveling side shots.

Level End (ER): Enter your value.

Note: You can add a note, or comments, into the editor as you move through the level run.
Adjust Elevations: This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you are running a 3 wire level loop the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop, the corrections will be averaged by the number of turns.

Store Elevations to Coordinate File: It is important that the point numbers in the level file match the point numbers in the coordinate file. If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.

Editor Columns:
Type: These are small pulldown menus with two-letter level procedure choices. The two letters are abbreviations as indicated in the next dialog. These steps may be made with the Add pulldown or with this method. The options are SR, TP, ER, LV and DS. DS stands for description shot.
Point # - Point number of measurement.
BS - Backsight rod reading
HI - Calculated height of instrument
FS - Foresight rod reading
Elevation - Elevation of point
Code: The code is used by SurvNet for network least-squares processing of networked level loops. The code can be either EL or FE where EL is for calculated elevations and FE is for fixed elevations. FE should only be assigned to a START or END record (where you can enter the value for the adjusted elevation). If FE is assigned to an intermediate record it is ignored. Here is how the FE records are used. Say you run from one benchmark to another (point 1 to point 10). Point 1 and point 10 are the START and END records of the first loop and both are FE records.
Then you start another loop at point 5 (halfway between 1 and 10). This is not a benchmark and can be adjusted so it should be assigned an EL code. Point 5 is the START record for the second loop. You run from point 5 to point 20 which is a benchmark. Point 20 is the END record and is assigned an FE code. When SurvNET processes the file, it will hold points 1, 10 and 20, allowing all others to be adjusted, including point 5 (even though it is a START record).

**Adjusted Elevation** - Adjusted elevation of point

**Description** - description of point

**TLV File Editor:**

TLV files can contain trig-level and/or differential level data. The editor will allow both type records in the same file.

Below is a sample Trig-Level TLV file:

```plaintext
Menu Options:

**File Menu:**

**Open** - Open an existing .TLV file.
```
New - Creates a new TLV level file.
Save - Save changes
Save As - Save as different file name
Settings - Not used with TLV files.

Import - You can import the following level file formats: Leica GSI format, Leica XML format, and Trimble DAT format.

Print - get hard copy printout of data.
Exit - Exit Level Editor Program

Edit Menu:
Clipboard: Cut, Copy, Paste
Go To - "Go To" will take you to the row of your choosing. Enter the row number.

Add Menu:
Add: These options allow you to add or insert a new record into the level editor.
Benchmark Record (BM): Point with known elevation.
Backsight Record (BS): Differential-level measurement to the backsight point.
Foresight Record (FS): Differential-level measurement to foresight point.
Backsight Record (BT): Trig-level measurement to the backsight point.
Foresight Record (FT): Trig-level measurement to foresight point.
Note: You can add a note, or comments, into the editor as you move through the level run.

Tools Menu:
Adjust Elevations: This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you have distances, either HD or SD for all your measurements, the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop (VD but no HD), the corrections will be averaged by the number of turns.

Store Elevations to Coordinate File: It is important that the point numbers in the level file match the point numbers in the coordinate file. If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.

Editor columns

Measurement records will have the following columns:

Trig Level Record:
Type - Two character abbreviation that shows the record type:
BM - Benchmark
BS - Differential-level backsight record
BT - Trig-Level backsight record
FS - Differential-level foresight record
FT - Trig-Level foresight record
DS - Note or Comment
Point # - Point number of measurement.
RodHt - Rod reading
Zenith - Zenith angle
S.Dist - Slope Distance
HI/Elev - Elevation of HI if a backsight record, or the foresight point if a foresight record
Adjusted Elevation - Adjusted elevation of foresight point
Description - description of point

Differential Level Record:
Type - Two character abbreviation that shows the record type, same as above.
Point # - Point number of measurement.
V.Diff - Rod Reading
H.Dist - Horizontal Distance
HI/Elev - Elevation of HI if a backsight record, or the foresight point if a foresight record
Adjusted Elevation - Adjusted elevation of foresight point
Description - description of point

Pulldown Menu Location: Survey
Keyboard Command: diglevel
Prerequisite: .LEV (level) file to process

Edit Process SDMS File
This command processes SDMS format raw data from PRJ files. There is a spreadsheet editor with the data tag, value and description for each of the records. The processing functions are the same as the Edit Process Raw Data command. See that section of the manual for a description of the processing functions. The Edit Process SDMS command allows you to work with the SDMS raw data in its native format. Alternatively, you can run Edit Process Raw Data and convert the SDMS PRJ file into a Carlson RW5 file.

![Edit Process Raw Data](image)

Pulldown Menu Location: Survey
Keyboard Command: sdmsedit
Prerequisite: None

SurvNET
Introduction
Key Features of SurvNet
- SurvNet reduces survey field measurements to coordinates in assumed, UTM, SPC83 SPC27, and a variety of other coordinate systems. SurvNET calculates the minimum necessary corrections to measured horizontal angles, slope distances and vertical angles in order to fit the desired control. SurvNET can only process raw field measurements, it is not designed to process bearing or azimuth traverses. If you wish to use
SurvNET to process your traverses, you must collect the angles and distances.

- In the 2D/1D model in a state plane coordinate system, a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to compute the elevation factor.

- SurvNet supports a variety of map projections and coordinate systems including the New Brunswick Survey Control coordinate system, UTM, and user defined systems consisting of either a predefined ellipsoid or a user defined ellipsoid and one of the following projections, Transverse Mercator, 1 Standard Parallel Lambert Conformal, 2 Standard Parallel Lambert Conformal, Oblique Mercator, and the Double Stereographic projection.

- A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment.

- Coordinates can be stored in a Carlson (.CRD) file, C&G (.CRD) file, Simplicity file (.ZAK) or an LDD file. An ASCII coordinate (.NEZ) file is always created that can be imported into most any mapping/surveying/GIS program. The user has the option to compute unadjusted preliminary coordinates.

- There is an option to compute traverse closures during the preprocessing of the raw data. Closures can be computed for both GPS loops and total station traverses. Closure for multiple traverse loops in the same raw file can be computed.

- When processing Angle-Only records for triangulation, if there is a zenith angle and rod height (zero is a valid rod height), a 3D triangulation will be performed, calculating an elevation of the triangulation point. This is true in both the 3D and 2D/1D models.

- SurvNet can combine GPS vectors and total station data in a single adjustment. GPS Vector files from Leica, Thales, Topcon and Trimble can be input, as well as GPS files in the StarNet format. Additionally GPS vectors can be read from NGS G-files. There is also an option to read the G-file section of an Opus report.

- SurvNet includes a variety of blunder detection routines. One blunder detection method is effective in detecting if the same point number has been used for two different points. Additionally this blunder detection method is effective in detecting if two different point numbers have been used for the same physical position. This method also flags other raw data problems. Another blunder detection method included in SurvNet is effective in isolating a single blunder, distance or angle in a network. This method does not require that there be a lot of redundancy, but is effective if there is only one blunder in the data set. Additionally, SurvNet includes a blunder detection method that can isolate multiple blunders, distances or angles in a network. This method does require that there be a lot of redundancy in the network to effectively isolate the multiple blunders.

- Other key features include: Differential and Trig level networks and loops can be adjusted using the network least squares program. Geoid modeling is used in SurvNet, allowing the users to choose between the Geoid99 and the Geoid03 model. The user can alternately enter the project geoid separation. There are description codes to identify duplicate points with different point numbers. The user can specify the confidence interval from 50 to 99 percent.

SurvNet performs a least squares adjustment and statistical analysis of a network of raw survey field data, including total station measurements, differential level data and GPS vectors. SurvNet simultaneously adjusts a network of interconnected traverses with any amount of redundancy. The raw data can contain any combination of angle and distance measurements, and GPS vectors. SurvNet can adjust any combination of trilaterations, traverses, triangulations, networks and resections. The raw data does not need to be in a linear format, and individual traverses do not have to be defined using any special codes. All measurements are used in the adjustment.

SurvNet implements the standard parametric observation equation method with independent weighting for azimuths, directions, angles, distances, GPS baselines, coordinates, elevations and level data to compute least squares estimates of all unknowns in accordance with well established reference texts such as Adjustment Computations:
General Rules for Collecting Data for Use in Least Squares Adjustments

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles, and distances combined with a minimal amount of control points and azimuths are needed. This data can be collected in any order. There needs to be at least some redundancy in the measurements. Redundant measurements are measurements that are in excess of the minimum number of measurements needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS and other control points within a network or traverse. Measuring angles and distances to points in the network that have been located from another point in the survey creates redundancy. Running additional cut-off traverses or additional traverses to existing control points creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNet requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and reference azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible, though unusual, to have one control point on one side of the project and a reference azimuth on the other side of the project.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNet requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly. An alternative to renumbering the points in the raw data file is to use the 'Pt Number substitution string' feature in the project 'Settings' screen. See the 'Redundant Measurement' section for more details on this feature.
- The majority of all problems in processing raw data are related to point numbering problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- A big source of problems with new users is a misunderstanding in defining their control for a project. It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file.
- Some raw data collector files may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points. Since there is no concept of 'starting coordinates' in least squares there is no way for SurvNet to determine which points are considered control and which points are preliminary unadjusted points. So all coordinates found in a raw data file will be considered control points.
- When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects. Once the smaller projects are processing separately they can be combined for a final combined adjustment.

SurvNet gives the user the option to choose one of two mathematical model options when adjusting raw data, the 3D model and the 2D/1D model.

In the process of developing SurvNet numerous projects have been adjusted using both the 2D/1D model and the 3D model. There are slight differences in final adjusted coordinates when comparing the results from the same network using the two models. But in all cases the differences in the results are typically less than the accuracy of measurements used in the project. The main difference in terms of collecting raw data for the two different models is that the 3D model requires that rod heights and instrument heights need to be measured, and there needs to be sufficient elevation control to compute elevations for ALL points in the survey. When collecting data for the 2D/1D model the field crews do not need to collect rod heights and instrument heights.
In the 2D/1D model raw distance measurements are first reduced to horizontal distances and then optionally to grid distances. Then a two dimensional horizontal least squares adjustment is performed on these reduced horizontal distance measurements and horizontal angles. After the horizontal adjustment is performed an optional one-dimensional vertical least squares adjustment is performed in order to adjust the elevations if there is sufficient data to compute elevations. The 2D/1D model is the model that has been traditionally been used in the past by non-geodetic surveyors in the reduction of field data. There are several advantages of SurvNet's implementation of the 2D/1D model. One advantage is that an assumed coordinate system can be used. It is not necessary to know geodetic positions for control points. Another advantage is that 3D raw data is not required. It is not necessary to record rod heights and heights of instruments. The 2D/1D model allows you to mix 2D and 3D measurements. Elevations are not required for the control points. The primary disadvantage of SurvNet's implementation of the 2D/1D model is that GPS vector data cannot be used in 2D/1D projects.

In the 3D model raw data is not reduced to a horizontal plane prior to the least squares adjustment. The 3 dimensional data is adjusted in a single least squares process. In SurvNet's implementation of the 3D model XYZ geodetic positions are required for control. The raw data must contain full 3D data including rod heights and measured heights of instrument. The user must designate a supported geodetic coordinate system. The main advantage of using the 3D model is that GPS vectors can be incorporated into the adjustment. Another advantage of the 3D model is the ability to compute and adjust 3D points that only have horizontal and vertical angles measured to the point. This feature can be used in the collection of points where a prism cannot be used, such as a power line survey.

When using the 2D/1D model if you have 'Vertical Adjustment turned' ON in the project settings, elevations will be calculated and adjusted only if there is enough information in the raw data file to do so. Least squares adjustment is used for elevation adjustment as well as the horizontal adjustment. To compute an elevation for the point the instrument record must have a HI, and the foresight record must have a rod height, slope distance and vertical angle. If working with .CGR raw data a 0.0 (zero) HI or rod height is valid. It is only when the field is blank that the record will be considered a 2D measurement. Carlson SurvCE 2.0 or higher allows you to mix 2D and 3D data by checking or unchecking the 3D MODE checkbox in the Configuration dialog (General Tab). A comment record "–Elevation: 3D" or "–Elevation: 2D" will be inserted into the .RW5 file and SurvNET will pay attention to those records. A 3D traverse must also have adequate elevation control in order to process the elevations. Elevation control can be obtained from the supplemental control file, coordinate records in the raw data file, or elevation records in the raw data file.

SurvNet can also automatically reduce field measurements to state plane coordinates in either the NAD 83 or NAD 27 or other supported geodetic coordinate systems. In the 2D/1D model a grid factor is computed for each individual line during the reduction. The elevation factor is computed for each individual line if there is sufficient elevation data. If the raw data has only 2D data, the user has the option of defining a project elevation to be used to compute the elevation factor.

A full statistical report containing the results of the least squares adjustment is produced and written to the report (.RPT) file. An error report (.ERR) file is created and contains any error messages that are generated during the adjustment. Coordinates can be stored in the following formats:

- C&G numeric (*.crd)
- C&G alphanumeric (*.cgc)
- Carlson numeric (*.crd)
- Carlson alphanumeric (*.crd)
- Carlson SQLite (*.crdb)
- MS Access Database (LDT) (*.mdb)
A file with the extension .OUT is always created and contains an ASCII formatted coordinate list of the final adjusted coordinates formatted suitable for printing. Additionally an ASCII file with an extension of .NEZ containing the final adjusted coordinates in a format suitable for input into 3rd party software that is capable of inputting an ASCII coordinate file.

SurvNet produces a wealth of statistical information that allows an effective way to evaluate the quality of survey measurements. In addition to the least squares statistical information there is an option to compute traverse closures during the preprocessing of the raw data. Traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traverse closures and for those surveyors who still like to view traverse closures prior to the least squares adjustment.

Starting Survnet

Using SurvNET Standalone

Double click on the SurvNET icon on the desktop or use the Start menu > Programs (or All Programs) > SurvNET

Running From Carlson:

Entry into the SurvNet program is easy. It can be accessed in two different ways. The easiest way to start the program is to select SurvNet from the Survey menu. The other method is to start SurvNet from within the Raw Data File editor. To bring up the Raw Data File editor select Edit-Process Raw Data File from the Survey menu (see below).

To access SurvNET from within the Carlson Raw Data Editor choose the Process (Compute Pts) menu then the SurvNET menu item (see below).
SurvNet Start-up Dialog

The SurvNet Start-up dialog is displayed when SurvNet is first started (see below). SurvNet is a project based program. Before performing a least squares adjustment an existing project must be opened or a new project created. This opening dialog box allows the user to open or create a project on start-up. You also can create or open a project from the Files menu. Since all project management functions can be performed from the Files menu you need not use the start-up dialog except as a convenience. If you do not wish to see the Start-up dialog when you start SurvNET, uncheck the Show this dialog box on start-up checkbox then click the Cancel button.

The following is a view of the SurvNet main window after an existing project has been opened.
Menu System Overview

The following graphic shows the main network least squares window. Least squares operations are initiated using the menus and toolbars found here.

File Menu

Selecting the File menu opens the following menu:

SurvNET projects
SurvNET is a project based system. Everything related to processing raw data must be specified in the project settings.

A Project (.PRJ) file is used to store all the settings and files necessary to reprocess the data making up the project. You can create a **New** project, or **Open** an existing project. It is necessary to have a project open in order to process the data.

The **Save Project As Default** can be used to create default project settings to be used when creating a new project. The current project settings are saved and will be used as the default settings when any new project is created. Project settings are covered in the Settings menu sections.

Some statutes and jurisdictions still require the computation of traditional traverse closures. SurvNet gives the surveyor the ability to compute the closures of multiple traverses within a project as part of the preprocessing of the project raw data. Closures for single or multiple traverses can be computed for a single project. Additionally, GPS closures can be computed for GPS loops. To compute closures you must first create a "Closure" file (.CLS). Closure files define the type of traverse loops that are to be computed and the point numbers that make up the traverse.

There are two options in the FILE menu that are used to create and edit the closure, .cls, files:

**Open Traverse Closure File**
**New Traverse Closure File**

After choosing the 'New Traverse Closure File' you will be prompted for a new file name. After choosing a file name the following dialog box is displayed.

First enter the point sequence which defines the traverse in the 'Ordered Traverse Point List' grid field. If you initiate the traverse closure input dialog from the FILE menu (as opposed to running it from the Settings Dialog), you will have the option to pick the points graphically.

Set the check boxes to set whether vertical closure and angle closures are to be computed. Then choose what type traverse is being entered.
Enter the points that define the traverse. If you check the "Allow graphic pt. pick" box, the graphic window will pop up. You can then pick the points graphically. The points will go into the list separated by commas.

If you manually enter the points, they can be entered in the form:

1,23,30-35,45,23,1

A comma separates the point numbers. You can select a range (30-35) when the points are sequential. You must start with the first back sight point number and end with the last foresight point number. For example, if you have a simple loop traverse with angle closure using points 1, 2, 3 and 4, it will be entered as "4,1,2,3,4,1" where 1 is the first occupied point and 4 is the initial back sight.

You can turn the "Angle Closure" ON or OFF. If the angle closure is ON, you will be shown the total angular error and error per angle point. If the final closing angle was not collected you can turn "Angle Closure" OFF and only the linear closure will be computed.

You can turn the "Vertical Closure" ON or OFF. If the vertical closure is ON, you will be shown the total vertical distance closure.

In order to calculate the traverse closure, you must select the TRAVERSE TYPE. It can be:

**Pt. to Pt. Trav.** - A point to point traverse is a traverse that starts at a set of known coordinates and ends at another known coordinate. This option assumes you start from two control points and tie into two control points if an angle closure is desired and one control point if only a linear closure is desired. The first back sight distance and last foresight distance if angle closure is ON are not used in computing the linear closure. Following is an example of a pt. to pt. traverse with angle closure.

100,101,2-5

In the above pt. to pt. list Pt 100 is the starting back sight point, Pt. 101 is the starting instrument point. Pt. 4 is the ending instrument point and the foresight to the angle closure point is point 5. If a closing angle was not collected the list would look as follows '100,101,2-4'.

**Loop Trav., Int. Az. Ref.** - A closed loop traverse that begins by backsighting the last interior point on the traverse. Following is an example.
7,101,2-7,101

In the above example closed loop with angle balance list, point 7 is the backsight point and point 101 is the first occupied point. If the closing angle 6-7-101 was not collected the list would be entered as follows ‘7,101,2-7’

**Loop Trav., Ext. Az. Ref.** - A closed loop traverse that begins by backsighting an exterior point (point not on the traverse).

100,101,2-7,101

In the above example loop with exterior reference and angle balance list, point 100 is the backsight point and point 101 is the first occupied point. If the closing angle 7-101-101 was not collected the list would be entered as follows ‘100,101,2-7,101’

**GPS Loop Closure**: GPS loop closures can be computed using this option.
A,E,F,A
In the above example GPS loop, closure will be computed from the GPS loop going from A-E-F-A.

After the closure, .CLS, file has been created the preprocessing project settings need to be updated to include the closure file in the project. Following is a view of the settings screen that defines a closure file to be used in preprocessing. Notice that the check box 'Compute Traverse Closure' is checked and a closure file has been entered in the edit box field. Notice that the 'Edit/Create' button can be used to edit an existing closure file or create a new closure file.

When the data is processed, the closure reports will appear in the RPT and ERR files. Traverse Closures will show the error of closure with and without angles balanced. Following is an example of a closed loop traverse report:

**Traverse Closures**

----------------
Traverse points:
103-118, 43-44

Traverse starting and ending on different points;
Compute angle closure.
Compute vertical closure.

<table>
<thead>
<tr>
<th>BS</th>
<th>IP</th>
<th>FS</th>
<th>Angle</th>
<th>FS H. Dist.</th>
<th>FS V. Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>104</td>
<td>105</td>
<td>173-07'48.5''</td>
<td>310.4916</td>
<td>-7.7483</td>
</tr>
<tr>
<td>104</td>
<td>105</td>
<td>106</td>
<td>167-48'21.5''</td>
<td>253.4909</td>
<td>5.6306</td>
</tr>
<tr>
<td>105</td>
<td>106</td>
<td>107</td>
<td>200-52'46.0''</td>
<td>381.4896</td>
<td>8.4879</td>
</tr>
<tr>
<td>106</td>
<td>107</td>
<td>108</td>
<td>149-09'05.5''</td>
<td>410.5470</td>
<td>-16.6830</td>
</tr>
<tr>
<td>107</td>
<td>108</td>
<td>109</td>
<td>080-42'36.5''</td>
<td>245.5728</td>
<td>9.4221</td>
</tr>
<tr>
<td>108</td>
<td>109</td>
<td>110</td>
<td>174-21'17.5''</td>
<td>175.3846</td>
<td>-5.6971</td>
</tr>
<tr>
<td>109</td>
<td>110</td>
<td>111</td>
<td>201-42'21.5''</td>
<td>367.0014</td>
<td>-11.8161</td>
</tr>
<tr>
<td>110</td>
<td>111</td>
<td>112</td>
<td>171-52'54.5''</td>
<td>237.7806</td>
<td>7.5346</td>
</tr>
<tr>
<td>111</td>
<td>112</td>
<td>113</td>
<td>192-32'53.5''</td>
<td>368.8396</td>
<td>-7.0329</td>
</tr>
<tr>
<td>112</td>
<td>113</td>
<td>114</td>
<td>171-30'59.0''</td>
<td>338.0024</td>
<td>-19.1945</td>
</tr>
<tr>
<td>113</td>
<td>114</td>
<td>115</td>
<td>184-54'03.5''</td>
<td>344.5005</td>
<td>16.3157</td>
</tr>
<tr>
<td>114</td>
<td>115</td>
<td>116</td>
<td>149-20'19.5''</td>
<td>353.8455</td>
<td>7.5562</td>
</tr>
<tr>
<td>115</td>
<td>116</td>
<td>117</td>
<td>202-19'01.5''</td>
<td>390.1117</td>
<td>-9.9180</td>
</tr>
<tr>
<td>116</td>
<td>117</td>
<td>118</td>
<td>112-36'32.0''</td>
<td>293.9931</td>
<td>2.0060</td>
</tr>
<tr>
<td>117</td>
<td>118</td>
<td>43</td>
<td>146-06'36.5''</td>
<td>411.3674</td>
<td>-7.7112</td>
</tr>
<tr>
<td>118</td>
<td>43</td>
<td>44</td>
<td>270-04'01.5''</td>
<td>237.7806</td>
<td>7.5346</td>
</tr>
</tbody>
</table>

Closing Az: S 47-39'47.8'' W
Computed Closing Az: S 47-39'51.3'' W
Total angular error: 000-00'03.5''
Angular error per point: 000-00'00.2''

Correct Ending Coordinates, North: 1400952.0140 East: 2241884.7010
Ending Coordinates, North: 1400951.7962 East: 2241884.8180
Error, N: -0.2178 E: 0.1170 Total: 0.2472 Brg: N 28-14'34.6'' W
Distance Traversed: 4882.4190 Closure: 1:19751
Correct Ending Elevation: 948.1710
Ending Elevation: 948.1221
Elevation Error: -0.0489

Closure After Angle Adjustment

<table>
<thead>
<tr>
<th>BS</th>
<th>IP</th>
<th>FS</th>
<th>Angle</th>
<th>FS H. Dist.</th>
<th>FS V. Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>103</td>
<td>104</td>
<td>105</td>
<td>173-07'48.3''</td>
<td>310.4916</td>
<td>-7.7483</td>
</tr>
<tr>
<td>104</td>
<td>105</td>
<td>106</td>
<td>167-48'21.3''</td>
<td>253.4909</td>
<td>5.6306</td>
</tr>
<tr>
<td>105</td>
<td>106</td>
<td>107</td>
<td>200-52'45.8''</td>
<td>381.4896</td>
<td>8.4879</td>
</tr>
<tr>
<td>106</td>
<td>107</td>
<td>108</td>
<td>149-09'05.3''</td>
<td>410.5470</td>
<td>-16.6830</td>
</tr>
<tr>
<td>107</td>
<td>108</td>
<td>109</td>
<td>080-42'36.3''</td>
<td>245.5728</td>
<td>9.4221</td>
</tr>
<tr>
<td>108</td>
<td>109</td>
<td>110</td>
<td>174-21'17.3''</td>
<td>175.3846</td>
<td>-5.6971</td>
</tr>
<tr>
<td>109</td>
<td>110</td>
<td>111</td>
<td>201-42'21.3''</td>
<td>367.0014</td>
<td>-11.8161</td>
</tr>
<tr>
<td>110</td>
<td>111</td>
<td>112</td>
<td>171-52'54.3''</td>
<td>237.7806</td>
<td>7.5346</td>
</tr>
</tbody>
</table>
Following is an example of a GPS loop closure report.

**Traverse Closures**

---

**GPS Loop Points:**
A, E, F, A

**GPS Loop Closure:**
- Misclosure, X: -0.0323
  - Y: -0.0162
  - Z: -0.0105
- Closure error: 0.0376
- Perimeter: 20229.3858
- Precision: 1:537594

**GPS Loop Points:**
C, F, D, B, C

**GPS Loop Closure:**
- Misclosure, X: -0.0121
  - Y: -0.0101
  - Z: 0.0002
- Closure error: 0.0158
- Perimeter: 41332.9807
- Precision: 1:2622216

Chapter 3. Survey Module
GPS Loop Points:
F,D,B,F

GPS Loop Closure:

Misclosure, X:
-0.0022
Y:
-0.0044
Z:
0.0097
Closure error:
0.0109
Perimeter: 30814.5047
Precision: 1:2833226

Following is a view of the closure file that created the above GPS closure report. The 'Vert. Closure', and 'Angle Closure' toggles serve no purpose with GPS loop closures.

SurvNet provides the ability to generate reports that give the surveyor the information needed to determine if his survey is within ALTA positional tolerances. It is required that the user define which points are to be included in the ALTA testing. The points to be included for ALTA testing are defined in an .Alt file.

There are two options in the FILE menu that are used to create and edit the ALTA, .alt, files:

Open ALTA, Rel. Err. Ellipse File
New ALTA, Rel. Err. Ellipse File

After choosing the ALTA file to be created or edited the following dialog box is displayed.
The above dialog box allows the user to define the points to be included in the ALTA report processing. There are two sections in the .RPT file created through the ALTA reporting. The following report shows the sections of the ALTA report generated by the data in the dialog box. The first section of the report displays only the relative error ellipses between points. The point sequences used in this section come from the list on the right hand side of the above dialog box. The second section of the report performs an ALTA tolerance test and displays only those connections that fall outside of the ALTA tolerances (as set in the ADJUSTMENT tab of the SETTINGS dialog box). The program first checks the specific point sequences defined by the list on the right side of the dialog box. The program then checks all the connections between all the points listed on the left hand side of the dialog box.

When adding points to either section, you can choose the option to Allow graphic pt. pick. This option is only available if you run the ALTA dialog from the FILE menu (as opposed to from the Settings dialog). A graphic window will pop up and you can pick the points graphically that you want to include in the ALTA report.

There can be many connections to check if the point list on the left hand side of the dialog box has a lot of points. The user can limit the number of sequences to be displayed that fail the ALTA test by entering a number in the "Max. Connections to display" field.

Notice that you can enter points based on descriptions in the left hand list box. If you wished to check connections between all points with TP, EIP, MON descriptions, enter the descriptions in the edit field and press the 'Add' button. If TP, EIP, and MON represented traverse points, existing iron pipes and monuments then ALTA testing would be performed on those point types.

After you have created the .ALT point file you need to set a few project settings. These settings define the ALTA tolerances, specify the .ALT file to be used, and define the type of reporting to be generated. The 'Adjustment' tab sheet within the project 'Settings', has a relative error ellipse section where the ALTA report settings are located.

All the ALTA reporting settings reside within the Relative Error Ellipse box.

Note: You do not have to "Enable sideshots for relative error ellipses" to get an ALTA report on sideshots that are selected for the report. All points selected for the ALTA report will automatically be included in the computational process.
The 'Rel. Err. Points File:' check box must be checked, and an .ALT file must be chosen to get an ALTA report. The .ALT file defines which points will be included in the ALTA reporting. See the previous discussion on the creation of the .ALT file if you are unsure of how to create an .ALT file.

Check the 'Include ALTA tolerance report' check box to create the ALTA tolerance checking report section. If an .ALT file has been chosen then the relative error section of the report will always be generated.

Next make sure the appropriate tolerance and PPM has been defined. The ALTA standards define their positional standard as .07 plus 50 PPM. Additionally, the ALTA standards require that the computations be performed to a 95% confidence. The confidence interval is set in the 'Confidence Interval:' edit field.

After the project has been processed the ALTA/Relative Error portion of the report is displayed in the report window under its own tab.
The following is a sample ALTA report:

Relative Error and ALTA Tolerances
==================================

Alta Tolerance Report, Specific Connections, 95% Confidence Interval

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>500</td>
<td>204.4590</td>
<td>0.0384</td>
<td>0.0802</td>
<td>0.4790</td>
<td>0.0332</td>
<td>N 17-50'50.2''E</td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>502</td>
<td>66.8572</td>
<td>0.0415</td>
<td>0.0733</td>
<td>0.5658</td>
<td>0.0310</td>
<td>S 86-04'58.5''E</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>36</td>
<td>237.9748</td>
<td>0.1340</td>
<td>0.0819</td>
<td>1.6364</td>
<td>0.1340</td>
<td>N 00-00'00.0''E</td>
<td></td>
</tr>
</tbody>
</table>

All the connections between the following points were checked.


From the above points the following connections exceeded the tolerance of 0.070 + 0.50 PPM at the 95% CI.

Alta Tolerance Report, All Connections, 95% Confidence Interval

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>642</td>
<td>692</td>
<td>416.9231</td>
<td>0.1709</td>
<td>0.0908</td>
<td>1.8814</td>
<td>0.1046</td>
<td>S 79-32'05.0''E</td>
<td></td>
</tr>
<tr>
<td>641</td>
<td>642</td>
<td>491.0046</td>
<td>0.1759</td>
<td>0.0946</td>
<td>1.8597</td>
<td>0.1064</td>
<td>S 78-49'00.0''E</td>
<td></td>
</tr>
<tr>
<td>640</td>
<td>642</td>
<td>632.6614</td>
<td>0.1775</td>
<td>0.1016</td>
<td>1.7463</td>
<td>0.1016</td>
<td>S 74-34'49.3''E</td>
<td></td>
</tr>
<tr>
<td>642</td>
<td>673</td>
<td>529.6088</td>
<td>0.1680</td>
<td>0.0965</td>
<td>1.7412</td>
<td>0.1003</td>
<td>S 79-00'20.0''E</td>
<td></td>
</tr>
<tr>
<td>642</td>
<td>650</td>
<td>704.7900</td>
<td>0.1793</td>
<td>0.1052</td>
<td>1.7037</td>
<td>0.1038</td>
<td>S 82-47'35.0''E</td>
<td></td>
</tr>
<tr>
<td>640</td>
<td>647</td>
<td>538.1392</td>
<td>0.1640</td>
<td>0.0969</td>
<td>1.6925</td>
<td>0.1074</td>
<td>S 51-54'51.0''E</td>
<td></td>
</tr>
<tr>
<td>616</td>
<td>640</td>
<td>449.6151</td>
<td>0.1555</td>
<td>0.0925</td>
<td>1.6813</td>
<td>0.1039</td>
<td>S 48-04'30.0''E</td>
<td></td>
</tr>
<tr>
<td>640</td>
<td>646</td>
<td>840.1672</td>
<td>0.1791</td>
<td>0.1120</td>
<td>1.5994</td>
<td>0.1169</td>
<td>S 22-41'30.0''E</td>
<td></td>
</tr>
<tr>
<td>541</td>
<td>642</td>
<td>163.9307</td>
<td>0.1234</td>
<td>0.0782</td>
<td>1.5775</td>
<td>0.0599</td>
<td>S 87-42'15.0''E</td>
<td></td>
</tr>
<tr>
<td>547</td>
<td>642</td>
<td>646.1891</td>
<td>0.1607</td>
<td>0.1023</td>
<td>1.5705</td>
<td>0.0959</td>
<td>S 82-55'50.0''E</td>
<td></td>
</tr>
</tbody>
</table>

If the Ratio Actual/Allowable is 1.0 or less, the positional tolerance of the two points have passed the ALTA standards.

The first part of the report shows the SPECIFIC connections as specified in the ALT file.

The second part shows the ALL CONNECTIONS as specified in the ALT file. It is preceded by the list of selected points. All possible combinations of connections between these points are calculated. Based on the setting Maximum Connections to Display in the ALT file, that number of connections are shown, beginning with the largest Ratio Actual to Allowable. Only the connections that fail the ALTA standards will be shown. If all the points "pass" the ALTA standards, no points will be shown and you will see the message: All connection combinations passed the tolerance test.

Settings Menu
The project settings are set by selecting Settings > Project from the menu, or pressing the SE icon on the tool bar. The project settings dialog box has six tabbed windows, Coordinate System, Input Files, Preprocessing, Adjustment, Standard Errors, and Output Options. Following is an explanation of the different project settings tabbed windows.
Notice that there are two buttons at the lower left of the dialog box. The 'Save Project' button can be used to store the current settings to the active project. If there is no active project then the user will be prompted for a new project file name. Projects can also be saved using the 'File/Save Project' menu option from the main menu. The 'Save as Default' button can be used to save the current project settings as the default settings whenever a new project is created. Default project settings can also be defined using the 'File/Save Project as default' menu option from the main menu.

**Coordinate System**

The Coordinate System tab contains settings that relate to the project coordinate system, output units, the adjustment model and other geodetic settings.

You can select either the 3D model or the 2D/1D mathematical model. If you choose 2D/1D mathematical model you can choose to only perform a horizontal adjustment, a vertical adjustment or both. In the 3D model both horizontal and vertical are adjusted simultaneously. The 3D model requires that you choose a geodetic coordinate system. Local, assumed coordinate systems cannot be used with the 3D model. GPS vectors can only be used when using the 3D model.

If using the 2D/1D mathematical model you can select Local (assumed coordinate system), or a geodetic coordinate system such State Plane NAD83, State Plane NAD27, UTM, or a user-defined coordinate system as the coordinate system. When using the 3D model you cannot use a local system.

Select the 'Horizontal Units for' output of coordinate values (Meters, US Feet, or International Feet). In the 3D model both horizontal and vertical units are assumed to be the same. In the 2D/1D model horizontal and vertical units can differ. The 'Horizontal unit' setting in this screen refers to the output units. It is permissible to have input units in feet and output units in meters. Input units are set in the 'Input Files' tabbed screen.

If you choose SPC 1983, SPC 1927, or UTM, the appropriate zone will need to be chosen. The grid scale factor is computed for each measured line using the method described in section 4.2 of NPAA Manual NOS NGS 5, "State Plane Coordinate System of 1983", by James E. Stem.

If using the 2D/1D model and you select a geodetic coordinate system, you have a choice as to how the elevation factor is computed. You can choose to either enter a project elevation or you can choose to have elevations factors...
computed for each distance based on computed elevations. In order to use the ‘Compute Elevation from Raw Data’ all HI's and foresight rod heights must be collected for all points.

If you choose a geodetic coordinate system and are using the 2D/1D model you will want to select "Project Elevation" if any of your raw data measurements are missing any rod heights or instrument heights. There must be enough information to compute elevations for all points in order to compute elevation factors. For most survey projects it is sufficient to use an approximate elevation, such as can be obtained from a Quad Sheet for the project elevation.

**Geoid Modeling**

If you are using either the 3D or the 2D/1D adjustment model using SPC 1983 or UTM reduction you must choose a geoid modeling method. A project geoid separation can be entered or the GEOID99 or GEOID03 grid models can be used. The project must fall within the geographic range of the geoid grid files in order to use GEOID99 or GEOID03 models.

Geoid modeling is used as follows. Entering a 0.0 value for the separation is the method to use if you wish to ignore the geoid separation. In the 2D, 1D model it is assumed that elevations entered as control are entered as orthometric heights. Since grid reduction requires the data be reduced to the ellipsoid, the geoid separation is used to compute ellipsoid elevations. The difference between using geoid modeling and not using geoid modeling or using a project geoid separation is insignificant for most surveys of limited extents. In the 3D model it is also assumed that elevations entered as control are orthometric heights. Since the adjustment is performed on the ellipsoid, the geoid separation is used to compute ellipsoid elevations prior to adjustment. After the adjustment is completed the adjusted orthometric elevations will be computed from the adjusted ellipsoid elevations and the computed geoid separation for each point.

Geoid modeling is especially important for projects covering large extents. If you incorporate GPS vector data from an OPUS solution into your project it will be necessary to use geoid modeling, otherwise your results will be poor.

If you choose the GEOID99 or GEOID03 modeling option, geoid separations are computed by interpolation with data points retrieved from geoid separation files. The geoid separation files should be found in the primary installation directory. Grid files have an extension of .grd. These files should have been installed during the installation of SurvNet. These files can be downloaded from the Carlson/C&G website, carlsonsw.com, if needed. The geoid files used by SurvNet are not in the same format as the geoid files available from NGS. The geoid files used by SurvNet must come from Carlson/C&G, either installed during installation or downloaded from the Carlson website.

If you choose to enter a project geoid separation the best way to determine a project geoid separation is by using the GEOID03 option of the NGS on-line Geodetic Toolkit. Enter a latitude and longitude of the project midpoint and the program will output a project separation.

**Working With User-defined Coordinate Systems**

SurvNet allows the creation of user-defined geodetic coordinate systems (UDP). The ability to create user-defined coordinate system allows the user to create geodetic coordinate systems based on projections that are not explicitly supported by SurvNet. A SurvNet user-defined coordinate system consists of an ellipsoid, and a map projection. The ellipsoid can be one of the explicitly supported ellipsoids or a user-defined ellipsoid. The supported map projections are Transverse Mercator, Lambert Conformal Conic with 1 standard parallel, Lambert Conformal Conic with 2 standard parallels, Oblique Mercator (NGS), and Double Stereographic projection. User-defined coordinate systems are created, edited, and attached to a project from the Project Settings 'Coordinate System' dialog box. To attach an existing UDP file, *.udp, to a project use the 'Select' button. To edit an existing UDP file or create a new UDP file use the 'Edit' button.

The User-defined Oblique Mercator projection used by SurvNet uses the Oblique Mercator projection formulas published in the NGS document "State Plane Coordinate System of 1983" by James Stem. This implementation
of the Oblique Mercator projection uses the convention of the False North and East being the natural origin, as opposed to the origin being the center of the projection.

The following dialog box is used to create the user-defined coordinate system. The ellipsoid needs to be defined and the appropriate map projection and projection parameters need to be entered. The appropriate parameter fields will be displayed depending on the projection type chosen.

**Test** - Use the 'Test' button to enter a known latitude and longitude position to check that the UDP is computing correct grid coordinates. Following is the test UDP dialog box. Enter the known lat/long in the top portion of the dialog box then press 'Calculate' and the computed grid coordinates will be displayed in the 'Results' list box.
Load - Use the 'Load' to load the coordinate system parameters from an existing UDP.

Save - Use the 'Save' button to save the displayed UDP. The 'Save' button prompts the user to enter the UDP file name.

OK - Use the 'OK' button to save the UDP using the existing file name and return to the 'Coordinate System' dialog box.

Cancel - Use the 'Cancel' button to return to the 'Coordinate System' dialog box without saving any changes to the UDP file.

If you need to define an ellipsoid chose the 'User-Defined' ellipsoid option. With the user-defined ellipsoid you will then have the option to enter two of the ellipsoid parameter.

Input Files
**Raw Data Files:** Use the 'Add' button to insert raw total station files into the list. Use the 'Remove' button to remove raw files from the list. All the files in this list are included in the least squares adjustments. Having the ability to choose multiple files allows one to keep control in one file and measurements in another file. Or different files collected at different times can be processed all at one time. If you have multiple crews working on the same project using different equipment, you can have "crew-specific" raw data files with standard error settings for their particular equipment. Having separate data files is also a convenient method of working with large projects. It is often easier to debug and process individual raw files. Once the individual files are processing correctly all the files can be included for a final adjustment.

You can select C&G (.CGR) raw files, Carlson (.RW5) files or SDMS (.PRJ) files for processing. You cannot select different file types. For example, you cannot select both .CGR and .RW5 files in the same project to be processed at the same time. Notice that you have the ability to highlight multiple files when removing or adding files.

Carlson RW5 files can contain GPS vector records. If you wish to use the vectors from the RW5 file, check the "Include any GPS Vectors" box. You can also select RW5 files containing vectors in the GPS vector Files area.

**Level Raw Files:** Differential and Trig level files can be entered and processed. There are two type of level file supported by SurvNET:

- **.TLV files** - this is the new Carlson level file. It can contain Trig-Level and/or Differential-Level data. This is the file created by SurvCE version 2.0 or higher.
- **.LEV files** - this is Carlson's old level file format. It can contain single-wire or three-wire differential-level data.

You can view/edit these files by pressing the "Edit" button next to the level file input field.

Under the tools menu pull down, you have the option to convert level files from other formats to either a TLV or LEV format.

**GPS Vector Files:** GPS vector files can be entered and processed. Both GPS vector files and total station raw
files can be combined and processed together. You must have chosen the 3D mathematical model in the Coordinate System tab in order to include GPS vectors in the adjustment.

Currently, the following GPS vector file formats are supported.

ASCII (StarNET)
Ashtech / Thales: Thales files typically have .obn extensions and are binary files.
Carlson RW5 files containing GPS vector records
GeoLab (.JOB)
LandXML, (*.xml)
Leica: Leica files are ASCII files.
NGS G-File
NGS G-File from an OPUS report
StarNet ASCII GPS: See below for more information on StarNet format. These files typically have .GPS extensions.
Topcon (.tvf): Topcon .tvf files are ASCII files.
Topcon (.xml): Topcon also can output their GPS vectors in XML format which is in ASCII format.
Trimble Data Exchange Format (.asc): These files are in ASCII format
Trimble data collection (.dc): These files are ASCII.
Trimble LandXML (.jxl)

The following is a typical vector record in the StarNet ASCII format. GPS vectors typically consist of the 'from' and 'to' point number, the delta X, delta Y, delta Z values from the 'from' and 'to' point, with the XYZ deltas being in the geocentric coordinate system. Additionally the variance/covariance values of the delta XYZ's are included in the vector file.

G0 'V3 00:34 00130015.SSF
G1 400-401 4725.684625 -1175.976652 1127.564218
G2 1.02174748583350E-007 2.19210810829205E-007 1.23924502584092E-007
G3 6.0655246633441E-008 -5.58807795027874E-008 -9.11050726758263E-008

The GO record is a comment. The G1 record includes the 'from' and 'to' point and the delta X, delta Y, and delta Z in the geocentric coordinate system. The G2 record is the variance of X, Y, and Z. The G3 record contains the covariance of XY, the covariance ZX, and the covariance ZY. Most all GPS vector files contain the same data fields in varying formats.

Use the 'Add' button to insert GPS vector files into the list. Use the 'Delete' button to remove GPS vector files from the list. All the files in this list will be used in the least squares adjustments. All the GPS files in the list must be in the same format. If the GPS file format is ASCII you have the option to edit the GPS vector files. The Edit option allows the editing of any of the ASCII GPS files using Notepad. Typically, only point numbers would be the fields in a GPS vector file that a user would have need to edit. The variance/covariance values are used to determine the weights that the GPS vectors will receive during the adjustment and are not typically edited.

For a variety of reasons it is common for GPS vector data collected with GPS equipment to have point names that do not match the point names used in the total station data. Generally the easiest way to handle this situation is to first convert the GPS data into the StarNet ASCII format using the 'Tools/Convert GPS file to ASCII' menu option. Once the file has been converted to ASCII it is straightforward to change the G1 records using any text editor to reflect the correct point numbers.

Supplemental Control File: The supplemental control file option allows the user to designate an additional coordinate file to be used as control. The supplemental control files can be from a variety of different file types.

Carlson SQLite (*.crdb)
C&G numeric (*.crd)
C&G alphanumeric (*.cgc)
Carlson numeric (*.crd)
Carlson alphanumeric (*.crd)
Autodesk Land Desktop (*.mdb)
Simplicity (*.zak)
ASCII P,N,E,Z,D,C (*.nez)
ASCII P, Lat, Long, Ortho, D,C (*.txt)
CSV ASCII NEZ with std. errors
SDMS (.ctl) control file

Note: You should never use the same file for supplemental control points and for final output. Least squares considers all points to be measurements. If the output file is also used as a supplemental control file then after the project has been processed all the points in the project would now be in the control file and all the points in the file would now be considered control points if the project was processed again. The simplest and most straight-forward method to define control for a project is to include the control coordinates in a raw data file.

Preprocessing

The Preprocessing tab contains settings that are used in the preprocessing of the raw data.

Apply Curvature and Refraction Corrections: Set this toggle if you wish to have the curvature refraction correction applied. Curvature/refraction primarily impacts vertical distances.

Tolerances: When sets of angles and/or distances are measured to a point, a single averaged value is calculated for use in the least squares adjustment. You may set the tolerances so that a warning is generated if any differences between the angle sets or distances exceed these tolerances. Tolerance warnings will be shown in the report (.RPT) and the (.ERR) file after processing the data.

Extended Angle Sets & Distance Report: If you check this box, you will get an expanded tolerance report. You will see a list of angles, distances, zenith angles and vertical differences that were averaged to get the single measurement used in the adjustment. If the list exceeds the tolerance settings, you will also see a warning. This will make for a much longer report. Below is a sample of the extended report:
Horizontal Angle: IP: 122, BS: 142, FS: 123
265-29'23.0''
265-29'21.0''
Average: 265-29'22.0''

Distance: From: 104, To: 103
090-37'11.0'' 324.8900 324.8710 -4.3718
090-37'06.0'' 324.8900 324.8711 -4.3640
089-01'54.0'' 324.9150 324.8685 4.4032
089-01'50.0'' 324.9150 324.8684 4.4095
090-37'03.0'' 324.8900 324.8712 -4.3592
090-37'10.0'' 324.8900 324.8711 -4.3703
089-03'59.0'' 324.9200 324.8768 4.3864
089-04'05.0'' 324.9200 324.8769 4.3769
Average 089-50'02.2'' 324.8878 324.8719 -4.3802

Vertical Distance from 104 to 103 exceeds tolerance:
Low: 4.3592, High: 4.4095, Diff: 0.0502

Horz./Slope Dist Tolerance: This value sets the tolerance threshold for the display of warnings if the difference between highest and lowest horizontal distance exceeds this value. In the 2D model it is the horizontal distances that are being compared. In the 3D model it is the slope distances that are being compared.

Vert. Dist Tolerance: This value sets the tolerance threshold for the display of a warning if the difference between highest and lowest vertical difference component exceeds this value (used in 2D model only).

Angle Set Spread Display: You can choose either individual angle spreads or SET angle spreads. If you choose individual, all the angles will be compared and a high and low will be determined. If you choose SETS, we will treat a SET (two angles) as a single angle by averaging them prior to comparing to another SET. If you only turn one SET of angles, there will be no tolerance check. If you turn 4 SETS of angles, the tolerance will be calculated from four angles.

Horz. Angle Tolerance: This value sets the tolerance threshold for the display of a warning if the difference between the highest and lowest horizontal angle exceeds this value (or highest and lowest SET depending on the previous setting). Vert. Angle Tolerance: This value sets the tolerance threshold for the display a warning if the difference between the highest and lowest vertical angle exceeds this value (used in 3D model only).

Compute Traverse Closures: Traditional traverse closures can be computed for both GPS loops and total station traverses. This option has no effect on the computation of final least squares adjusted coordinates. This option is useful for surveyors who due to statutory requirements are still required to compute traditional traverse closures and for those surveyors who still like to view traverse closures prior to the least squares adjustment. This option is used to specify a previously created closure file.

To use this option the user has to first create a traverse closure file. The file contains a .cls extension. The traverse closure file is a file containing an ordered list of the point numbers comprising the traverse. Since the raw data for SurvNet is not expected to be in any particular order it is required that the user most specify the points and the correct order of the points in the traverse loop. Both GPS loops and angle/distance traverses can be defined in a single traverse closure file. More details on creating the traverse closure files follow in a later section of this manual.

Pt. Number Substitution String: This option is used to automatically renumber point names based on this string. Some data collectors do not allow the user to use the same point number twice during data collection. In least squares it is common to collect measurements to the same point from different locations. If the data collector
does not allow the collection of data from different points using the same point number this option can be used to automatically renumber these points during processing. For example you could enter the string '=' in the Pt. Number Substitution String. Then if you shot point 1 but had to call it something else such as 101 you could enter '='1' in the description field and during preprocessing point 101 would be renumbered as point '1'. With small projects it may be just as easy to edit the raw data.

Adjustment

**Maximum Iterations:** Non-linear least squares is an iterative process. The user must define the maximum number of iterations to make before the program quits trying to find a converging solution. Typically if there are no blunders in the data the solution will converge in 2-5 iterations.

**Convergence Threshold:** During each iteration corrections are computed. When the corrections are less than the threshold value the solution has converged. This value should be somewhat less than the accuracy of the measurements. For example, if you can only measure distances to the nearest .01’ then a reasonable convergence threshold value would be .005’.

**Confidence Interval:** This setting is used when calculating the size of error ellipses, and in the chi-square testing. For example, a 95% confidence interval means that there is a 95% chance that the error is within the tolerances shown.

**Enable sideshots for relative error ellipses:** Check this box if you want to see the error ellipses and relative error ellipses of sideshots. This checkbox must be set if you want to use the “relative error ellipse inverse” function with sideshots. When turned off this toggle filters out sideshots during the least squares processing. Since the sideshots are excluded from the least squares processing error ellipses cannot be computed for these points. When this toggle is off, the sideshots are computed after the network has been adjusted. The final coordinate values of the sideshots will be the same regardless of this setting.

Large numbers of sideshots slow down least squares processing. It is best to uncheck this box while debugging your project to avoid having to wait for the computer to finish processing. After the project processes correctly you may turn on the option for the final processing.
Note: If you wish to get statistics on certain selected sideshots, you can create an ALT file with the selected points. This will force them to be included in the calculation process - even if you have “Enable sideshots for relative error ellipses” unchecked.

**Relative Err. Points File:** The ALTA standards require that surveyors certify to the relative positional error between points. Relative error ellipses are an accepted method of determining the relative positional error required by the ALTA standards. The points that are to be included in the relative error checking are specified by the user. These points are defined in an ASCII file with an extension of .alt. To select an .alt file for relative error checking use the 'Select' button and then browse to the file's location.

There is a section later in the manual that describes how to create and edit the .alt file.

**Include ALTA tolerance report:** Turn this toggle on if you wish to include the ALTA tolerance section of the report.

Allowable Tolerance, PPM: These fields allow the user to set the allowable error for computations. Typically the user would enter the current ALTA error standards, i.e. 0.07' & 50 PPM.

See the later section in this manual for more detailed information on creating and interpreting the ALTA section of the report.

**Standard Errors**

![Image of Standard Errors settings](image)

Standard errors are the expected measurement errors based on the type equipment and field procedures being used. For example, if you are using a 5 second total station, you would expect the angles to be measured within +/- 5 seconds (Reading error).

The Distance Constant, PPM settings, and Angle Reading should be based on the equipment and field procedures being used. These values can be obtained from the published specifications for the total station. Or the distance PPM and constant can be computed for a specific EDM by performing an EDM calibration using an EDM calibration baseline.

Survey methods should also be taken into account when setting standard errors. For example, you might set the
target centering standard error higher when you are sighting a held prism pole than you would if you were sighting a prism set on a tripod.

The settings from this dialog box will be used for the project default settings. These default standard errors can be overridden for specific measurements by placing SE records directly into the Raw Data File (see the above section on raw data files).

If the report generated when you process the data shows that generally you have consistently high standard residuals for a particular measurement value (angles, distances, etc.), then there is the chance that you have selected standard errors that are better than your instrument and methods can obtain. (See explanation of report file). Failing the chi-square test consistently is also an indication that the selected standard errors are not consistent with the field measurements.

You can set the standard errors for the following:

**Distance and Angle Standard Errors**

**Distance Constant:** Constant portion of the distance error. This value can be obtained from published EDM specifications, or from an EDM calibration.

**Distance PPM:** Parts per million component of the distance error. This value can be obtained from published EDM specification, or from an EDM calibration.

**Horizontal Angle Pointing:** The horizontal angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Horizontal Angle Reading:** Precision of horizontal angle measurements, obtain from theodolite specs.

**Vertical Angle Pointing:** The vertical angle pointing error is influenced by atmospheric conditions, optics, experience and care taken by instrument operator.

**Vertical Angle Reading:** Precision of vertical angle measurements, obtain from theodolite specs.

**Instrument and Target Standard Errors**

**Target Centering:** This value is the expected amount of error in setting the target or prism over the point.

**Instrument Centering:** The expected amount of error in setting the total station over the point.

**Target Height:** The expected amount of error in measuring the height of the target.

**Instrument Height:** The expected amount of error in measuring the height of the total station.

**Control Standard Errors**

**Direction (Bearing / Azimuth):** The estimated amount of error in the bearing / azimuth (direction) found in the azimuth records of the raw data.

**North, East, Elev:** The estimated amount of error in the control north, east and elev. You may want to have different coordinate standard errors for different methods of obtaining control. Control derived from RTK GPS would be higher than control derived from GPS static measurements.

**GPS Standard Errors**

**Instrument Centering:** This option is used to specify the error associated with centering a GPS receiver over a point.

**Vector Standard Error Factor:** This option is used as a factor to increase GPS vector standard errors as found in the input GPS vector file. Some people think that the GPS vector variances/covariances as found in GPS vector files tend to be overly optimistic. This factor allows the user to globally increase the GPS vector standard errors without having to edit the GPS vector file. A factor of 0 should be the default value and results in no change to the GPS vector standard errors as found in the GPS vector file. The maximum value allowed is 10.

**Differential Leveling Standard Errors**

These setting only effect level data and are not used when processing total station or GPS vector files.
Avg, Dist. To BS/FS: This option is used to define the average distance to the backsight and foresight during leveling.

Rod Reading Error per 100 ft./m: This option is used to define the expected level reading error.

Collimation Error: This is the expected differential leveling collimation error in seconds.

Standard Error Definition Files

The Standard error settings can be saved and then later reloaded into an existing or new project. Creating libraries of standard errors for different types of survey equipment or survey procedures is a convenient method of creating standards within a survey department that uses a variety of equipment and performs different types of surveys. Standard error library files, *.sef files, can be created two ways. From the 'Settings/Standard Errors' dialog box the 'Load' button can be used to import an existing .sef file into the current project. A .sef file can also be created from the existing project standard errors by using the 'Save As..' button.

Standard error files, .sef files, can also be managed from the main 'Files' menu. Use the 'Edit Standard Error File' menu option to edit an existing standard error file. Use the 'New Standard Error File' option to create a new standard error file.

After choosing one of the menu options and choosing the file to edit or create, the following dialog box will be shown. Set the desired standard errors and press the 'OK' button to save the standard error file.
These settings apply to the output of data to the report and coordinate files.

Display Precision

These settings determine the number of decimal places to display in the reports for the following types of data. The display precision has no effect on any computations, only the display of the reports.
Coordinates (North, East, Elevation) - Chose 0-4 decimal places.
Distances - Chose 0-4 decimal places
Directions (Azimuths or Bearings) - nearest second, tenth of second, or hundredth of second.

Format

These settings determine the format for the following types of data.

Direction - Choose either bearings or azimuth for direction display. If the angle units are degrees, bearings are entered as QDD.MMSSss and azimuths are entered as DDD.MMSSss. If the angle units are grads, bearings are input as QGGG.ggggg and azimuths are input as GGG.ggggg.

Coordinate Display - Choose the order of coordinate display, either north-east or east-north.

Null Elevation - Choose the value for null elevations in the output ASCII coordinate NEZ file. The Null Elevation field defaults to SurvNet's value for NO ELEVATION, of -999999999.0 .

Angle Display - Choose the units you are working in, degrees or gradians.

ASCII NEZ Output

These settings determine the type and format of the output NEZ file. An ASCII .NEZ and .OUT files are always created after processing the raw data. The .OUT file will be a nicely formatted version of the .NEZ file suitable for printing. The .NEZ file will be an ASCII file suitable to be input into other programs. There are a variety of options for the format of the .NEZ file. Following are the different ASCII file output options.

P,N,E,Z,CD,DESC (fixed columns); - Point,north,east,elev.,code,desc in fixed columns separated by commas.
P,N,E,Z,CD,DESC; Point,north,east,elev.,code,desc separated by commas.
P N E Z CD DESC (fixed columns); Point,north,east,elev.,code,desc in fixed columns with no commas.
P N E Z CD DESC; Point,north,east,elev.,code,desc in fixed columns with no commas.
P,N,E,Z,DESC (fixed columns); Point,north,east,elev., desc in fixed columns separated by commas.
P,N,E,Z,DESC; Point,north,east,elev., desc separated by commas.
P N E Z DESC (fixed columns); Point,north,east,elev., desc in fixed columns with no commas.
P N E Z DESC; Point,north,east,elev., desc separated by spaces.
P,E,N,Z,CD,DESC (fixed columns); - Point,east,north,elev.,code,desc in fixed columns separated by commas.
P,E,N,Z,CD,DESC; Point,east,north,elev.,code,desc separated by commas.
P E N Z CD DESC (fixed columns); Point,east,north,elev.,code,desc in fixed columns with no commas.
P E N Z CD DESC; Point,east,north,elev.,code,desc in fixed columns with no commas.
P,E,N,Z,DESC (fixed columns); Point,east,north,elev., desc in fixed columns separated by commas.
P,E,N,Z,DESC; Point,east,north,elev., desc separated by commas.
P E N Z DESC (fixed columns); Point,east,,northelev., desc in fixed columns with no commas.
P E N Z DESC; Point,east,north,elev.,code,desc separated by spaces.

CSV ASCII with std. errors (This format is useful as it can be used as a supplemental control input file type option, where the coordinate standard errors output for one project can be used as input for another project.)
You can also set the output precision of the coordinates for the ASCII output file. This setting only applies to ASCII files, not to the C&G or Carlson binary coordinate files which are stored to full double precision.

* N/E Precision: number of places after the decimal to use for North and East values (0 -> 8) in the output NEZ ASCII file.
* Elevation Precision: number of places after the decimal to use for Elevation values (0 -> 8) in the output NEZ ASCII file.

**Coordinate File Output**

If you want to write the calculated coordinates directly to a Carlson or C&G coordinate file, check the "Write to Coordinate File" box and select the file. You can choose the type of Carlson/C&G file to be created when you 'select' the file to be created. You may wish to leave this box unchecked until you are satisfied with the adjustment. Following are the different available coordinate output file options.

* NOTE: If coordinate points already exist in the CRD file, and they have different values, before a point is written, you will be shown the NEW value, the OLD value, and given the following option:

**Cancel:** Cancel the present operation. No more points will be written to the Carson/C&G file.

**Overwrite:** Overwrite the existing point. Notice that if you check the 'Do Not Ask Again' box all further duplicate points will be overwritten without prompting.

**Do not Overwrite:** The existing point will not be overwritten. Notice that if you check the 'Do Not Ask Again' box
all further duplicate points will automatically not be overwritten - only new points will be written.

## Scaled Coordinate File

This feature allows you to output to a second, "Scaled" coordinate file. The main purpose of this feature is to create a GROUND based coordinate file when working on a SPC system.

First check the "Create Scaled/Ground NEZ File" checkbox to turn the feature ON.

Select the TYPE coordinate file you wish to output to and select the file.

If your project is based on a SPC system, you will have the following scaling options:

- **To Ground. Use avg. computed combined SF**
- **Manually enter SF**

If you select the first option, the combined scale factor is calculated for each of the points and then the total is averaged. The inverse of this scale factor will be used to calculate the coordinates of the SCALED coordinate file. This will give you GROUND coordinates for the project.

If you wish, you may also manually enter the desired scale factor.

If your project is based on a Local or Assumed coordinate system, you will only have the option to manually enter the scale factor as the scale factors cannot be calculated.

Next you will enter the point number you wish to SCALE around:

- **Pt. to Scale**

Next you have the following TRANSLATION options:

- **Use current NE values**
- **Enter new NE values**
- **Enter translation values**

The first option will use the current coordinates of the SCALE POINT, all other coordinate points will be scaled around this point.

The second option allows you to enter NEW coordinate values for the SCALE POINT. All the points will first be translated so that the SCALE POINT has the values entered here and then they will be scaled around the SCALE POINT.

The third option allows you to directly enter the delta-north and delta-east translation values. All the points will first be translated and then scaled.

If the Scaled Coordinate file exists when you process the project, you will see the following warning dialog box:
If you pick OK the points in the Scaled File will be overwritten. If you Cancel no point will be written to the Scaled File.

**Process Menu**

When you select Process > Network Adjustment from the menu, or select the NETWORK ICON on the tool bar, the raw data will be processed and adjusted using least squares based on the project settings. If there is a problem with the reduction, you will be shown error messages that will help you track down the problem. Additionally an .err file is created that will log and display error and warning messages.

The data is first preprocessed to calculate averaged angles and distances for sets of angles and multiple distances. For a given setup, all multiple angles and distances to a point will be averaged prior to the adjustment. The standard error as set in the Project Settings dialog box is the standard error for a single measurement. Since the average of multiple measurements is more precise than a single measurement the standard error for the averaged measurement is computed using the standard deviation of the mean formula.

Non-linear network least squares solutions require that initial approximations of all the coordinates be known before the least squares processing can be performed. So, during the preprocessing approximate coordinate values for each point are calculated using basic coordinate geometry functions. If there is inadequate control or odd geometric situations SurvNet may generate a message indicating that the initial coordinate approximations could not be computed. The most common cause of this problem is that control has not been adequately defined or there are point number problems.

Side Shots are separated from the raw data and computed after the adjustment (unless the "Enable sideshots for relative error ellipses" toggle is checked in the adjustment dialog box). If side shots are filtered out of the least squares process and processed after the network is adjusted, processing is greatly speeded up, especially for a large project with a lot of side shots.

If the raw data processes completely, a report file, .RPT, a .NEZ file, an .OUT file, and an .ERR file will be created in the project directory. The file names will consist of the project name plus the above file extensions. These different files are shown in separate windows after processing. Additionally a graphic window of the network is displayed.

- **.RPT file**: This is an ASCII file that contains the statistical and computational results of the least squares processing.
- **.NEZ file**: This file is an ASCII file containing the final adjusted coordinates. This file can be imported into any program that can read ASCII coordinate files. The format of the file is determined by the setting in the project settings dialog box.
- **.OUT file**: The .OUT file is a formatted ASCII file of the final adjusted coordinates suitable for display or printing.
- **.ERR file**: The .ERR file contains any warning or error messages that were generated during processing. Though some warning messages may be innocuous it is always prudent to review and understand the meaning of the
The following is a graphic of the different windows displayed after processing. Notice that with the report file you can navigate to different sections of the report using the Tabs at the top of the window.

If you have "Write to Carlson/C&G.CRD" checked in the output options dialog, the coordinates will also be written to a .CRD file.

GPS vector networks can be adjusted with the current version of SurvNet. This chapter will describe the processing of a simple GPS network. Following is a graphic view of the GPS network that is to be adjusted. Points A and B are control points. The red lines represent measured GPS vectors. Most GPS vendor's software can output GPS vectors to a file as part of the post processing of GPS data.
When processing GPS vectors certain project settings are important. In the following settings dialog box notice that the 3D-model has been chosen, and SPC 1983 with an appropriate zone has been chosen. The 3-D model and a geodetic coordinate are required when processing GPS vectors. Though it is not require for GPS processing it is in most cases appropriate to chose to do geoid modeling, especially if the project covers a large extents. The following settings dialog box shows the raw files used in processing GPS files. A GPS vector file must be chosen.

GPS vector files from various GPS vendors are currently supported. Select the vector files to be processed:
Coordinate control for the network can be in one of several files. The control can be located in the GPS vector file itself. More typically, the control points can be regular coordinate records in the .RW5 or the .CGR file. The also can be entered as 'Supplemental Control' in one of the available formats. When the control coordinates are in the raw data file or supplemental coordinate file, the coordinates are expected to be grid coordinates. If the control coordinates are found in the GPS vector file, they are assumed to be Earth centered XYZ.

Very often the point numbering convention used in the GPS data collection is different than the point number convention used when collecting total station data. If the point numbers in the GPS file differ from the total station point number it is easy to first convert the native GPS format file to a ASCII .GPS using the 'Tools/Convert GPS file to ASCII' menu option. The .GPS ASCII files can easily be edited to ensure point numbers are consistent between GPS and total station data.

It is not unusual to have different distance units for GPS, total station data, and control data. Often the GPS vector data is in metric units but the total station raw file is in US Feet. So, the distance units must be specified for the different raw data types.

In the Preprocessing Settings dialog box the only important setting is the 'Compute Traverse Closures:' options. If GPS loop closures need to be computed, the loop point numbers need to be entered into a closure file. See the chapter on traverse closures to see how to create closure files.

There are two GPS standard errors fields in the Standard Errors Settings dialog box. The GPS vector XYZ standard errors and covariances do not need to be defined as project settings since they are typically found in the GPS vector data files. The Instrument centering standard error is the estimated error in centering the GPS unit over the survey point. The 'vector Std. Err. Factor' can be used to globally increase the variance/covariances found in the GPS files without having to edit the GPS file itself.
Processing a Total Station and a GPS Vector Network

Processing a GPS vector network together with conventional total station data is similar to processing a GPS network by itself. The only difference in regards to project settings is that a raw data file containing the total station data needs to be chosen as well as a GPS vector file. The project must be set up for the 3D model and a geodetic coordinate system needs to be chosen. The total station must contain full 3D data, including all rod heights and instrument heights measured. Following is a view of the Input Files Settings dialog box showing both a GPS vector file and a total station raw data file chosen in a single project. It is not uncommon to have different distance units for GPS data and total station data, so make sure the correct units are set for data types.

One of the most common problems for new users in combining GPS and total station data is not collecting HI's and rod heights when collecting the total station data. Since the 3D model is being used complete 3D data needs to be collected.

The 'Preprocess, compute unadjusted coordinates' option allows the computation of unadjusted coordinates. If there are redundant measurements in the raw data, the first angle and distance found in the raw data is used to compute the coordinates. If a state plane grid system has been designated the measurements are reduced to grid prior to the computation of the unadjusted coordinates. If the point is located from two different points the initial computation of the point will be the value stored.
A variety of blunder detection tools are available that gives the user additional tools in analyzing his survey data, and detecting blunders. The standard least squares adjustment processing and its resulting report can often be used to determine blunders. No blunder detection method can be guaranteed to find all blunders. So much depends on the nature of the network geometry, the nature of the measurements, and the intuition of the analyst. Generally, the more redundancy there is in a network the easier it is to detect blunders.

There are three different methods that can be used to track down blunders in a network or traverse.

Option 1) Preprocess the raw data:

The 'Preprocess the raw data' option validates the raw data. It displays angle and distance spreads as well as checks the validity of the raw data. Traverse closures are computed if specified. It also performs a "K-Matrix" analysis. The "K-Matrix" analysis compares the unadjusted, averaged measurements with the computed preliminary measurements (measurements calculated from the preliminary computed coordinates). This method will catch blunders such as using the same point number twice for two different points. The report will be sent to the ERR file. The ERR file will contain the tolerance checks, closures and the K-Matrix analysis. Following is an example of the report created using the 'Preprocess the raw data' option. Notice that the first section of the report shows the angle and distance spreads from the multiple angle and distance measurements. The second part of the report shows the 'K-matrix analyses.

Additionally there is a 'Point Proximity Report' section that reports pairs of different points that are in close proximity to each other which may indicate where the same point was collected multiple times using different point numbers.

The 'Preprocess the raw data' option is one of the simplest and effective tools in finding blunders. Time spent learning how this function works will be well spent. If the project is not converging due to an unknown blunder in the raw data this tool is one of the most effective tools in finding the blunder. Many blunders are due to point numbering errors during data collections, and the 'K-matrix' analysis and 'Point Proximity' search are great tools for finding this type blunders.
Checking raw data syntax and angle & distance spreads.

Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.00 180.00050 4
Warning: Missing Vert. Angle. Assumption made as to whether it is direct or reverse.
1 5.01 145.54300 2 H&T
Horizontal Angle spread exceeds tolerance:
IP: 1, BS: 5, FS: 2
Low: 109-19'10.0'', High: 109-19'17.0'', Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
IP: 2, BS: 1, FS: 6
Low: 190-32'02.0'', High: 190-32'10.0'', Diff: 000-00'08.0''

K-Matrix Analysis.

Distance: From pt.: 4 To pt.: 5
Measured distance: 309.61 Initial computed distance: 309.65
Difference: -0.04

Distance: From pt.: 12 To pt.: 3
Measured distance: 144.63 Initial computed distance: 144.66
Difference: -0.03

Distance: From pt.: 5 To pt.: 6
Measured distance: 348.51 Initial computed distance: 523.29
Difference: -174.79

Angle: IP: 4 BS: 3 FS: 5
Measured angle: 093-02'11.5''
Initial computed angle: 093-01'45.1''
Difference: 000-00'26.4''

Angle: IP: 12 BS: 11 FS: 3
Measured angle: 140-39'24.5''
Initial computed angle: 140-40'32.6''
Difference: -000-01'08.1''

Angle: IP: 5 BS: 4 FS: 1
Measured angle: 117-30'42.5''
Initial computed angle: 117-31'16.4''
Difference: -000-00'33.9''

Angle: IP: 5 BS: 4 FS: 6
Measured angle: 145-30'34.0''
Initial computed angle: 079-39'46.4''
Difference: 065-50'47.6''
Point Proximity Report:

Points 3 and 30 are within 0.05 of each other.

The problem with the above project was that point 6 was accidentally used twice for two separate side shots. Because of the point numbering problem the project would not converge, using the regular least squares processing. The 'Preprocess the raw data.' option was then used. Notice in the K-matrix section the distance from 5 to 6 shows a difference of 174.79' and the angle 4-5-6 shows a difference of 065-50'47.6''. Then notice that the other listed differences are in the range of .02' for the distances and less than a minute for the angles. This report is clearly pointing out a problem to point 6.

Note the point proximity report section. During data collection point number 30 was used as the point number when the point was previously collected as point 3.

In the first section of the report notice that there are several warnings concerning whether a horizontal angle reading was collected in direct or reverse reading. The preprocessing software uses the vertical angle reading to determine the angle face of the horizontal angle reading. If the vertical angle is missing the program makes its best guess as to whether the angle was collected in direct or reverse face. Since all horizontal angle spreads in the report are reasonable, the preprocessing software must have made the correct determination.

Option 2) Float one observation:

This option is useful in finding a single blunder, either an angle or distance, within a network or traverse. If there is more than a single blunder in the network then it is less likely that this method will be able to isolate the blunders. If the standard least squares processing results in a network that will not converge then this blunder detection method might not work. Use the 'Preprocess the raw data' blunder detection method if the solution is not converging. Also this method will only work on small and moderately sized networks. This method performs a least squares adjustment once for every non-trivial measurement in the network. So for large networks this method may take so long to process that it is not feasible to use this method.

With this method an adjustment is computed for each non-trivial individual angle and distance measurement. Consecutively, a single angle or distance is allowed to float during each adjustment. The selected floated angle or distance does not "constrain" the adjustment in any way. If there is a single bad angle or distance, one of the adjustment possibilities will place most of the error in the "float" measurement, and the other measurements should have small residuals. The potentially bad angle or distance is flagged with a double asterisk (**). Since an
The adjustments with the lowest reference variances are selected as the most likely adjustments that have isolated the blunder. You have the choice to view the best adjustment, or the top adjustments with a maximum of ten. In the above example we asked to see the top 5 choices for potential blunders. The results are shown in the ERR file. Following is a section of the report generated where an angular blunder was introduced into a small traverse. Notice the '**' characters beside the angle measurements. In this report the two most likely adjustments were displayed. The blunder was introduced to angle 101-2-3. Angle 101-2-3 was chosen as the 2nd most likely source of the blunder, showing that these blunder detection methods though not perfect, can be a useful tool in the analysis of survey measurements. Notice how much higher the standard residuals are on the suspected blunders than the standard residuals of the other measurements.

Adjusted Observations
=======================
Adjusted Distances
From Sta. To Sta. Distance Residual StdRes. StdDev
101 2 68.780 -0.006 0.608 0.008
2 3 22.592 -0.006 0.573 0.008
3 4 47.694 -0.002 0.213 0.008
4 5 44.954 -0.001 0.069 0.008
5 6 62.604 0.005 0.472 0.009
6 7 35.512 0.006 0.539 0.008
7 101 61.704 0.003 0.314 0.009
Root Mean Square (RMS) 0.005

Adjusted Angles
BS Sta. Occ. Sta. FS Sta. Angle Residual StdRes StdDev(Sec.)
7 101 2 048-05'06'' -5 0 21
101 2 3 172-14'33'' -2 0 27
2 3 4 129-27'44'' -222* 7 56 **
3 4 5 166-09'59'' 11 0 25
4 5 6 043-12'26'' 22 1 21
5 6 7 192-11'52'' 12 0 25
6 7 101 148-38'19'' 8 0 25
Root Mean Square (RMS) 85

Adjusted Azimuths
Occ. Sta. FS Sta. Bearing Residual StdRes StdDev(Sec.)
101 7 N 00-00'00''E 0 0 4
Root Mean Square (RMS) 0

Statistics
=============
Solution converged in 2 iterations
Degrees of freedom:3
Reference variance:0.78
Standard error unit Weight: +/-0.88
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 2.347 <= 9.348

Adjusted Observations
=======================
Adjusted Distances
From Sta. To Sta. Distance Residual StdRes. StdDev
<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle Residual</th>
<th>StdRes</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>101</td>
<td>2</td>
<td>048-05'22''</td>
<td>11 0 24</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>2</td>
<td>3</td>
<td>172-11'03''</td>
<td>-213 * 7 58 **</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>4</td>
<td>129-31'23''</td>
<td>-3 0 29</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>5</td>
<td>166-09'48''</td>
<td>1 0 26</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>6</td>
<td>043-12'11''</td>
<td>6 0 21</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>192-11'50''</td>
<td>10 0 27</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>101</td>
<td>148-38'24''</td>
<td>13 0 27</td>
<td></td>
</tr>
<tr>
<td>Root Mean Square (RMS)</td>
<td>81</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjusted Azimuths</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Occ. Sta.</td>
<td>FS Sta.</td>
<td>Bearing Residual</td>
<td>StdRes</td>
<td>StdDev (Sec.)</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>7</td>
<td>N-00-00'00''E</td>
<td>-0 0 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Root Mean Square (RMS)</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Statistics
==========
Solution converged in 2 iterations
Degrees of freedom: 3
Reference variance: 0.89
Standard error unit Weight: +/-0.94
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 2.675 <= 9.348

The blunder is most likely in the measurement containing the largest residual and standard residual. The observation marked with ** is the observation that floated. It is also most likely the measurement containing the blunder.

Option 3) Re-weight by residuals & std err:
This method is capable of detecting multiple blunders but one is more likely to find the blunders if there is a high degree of redundancy (network of interconnected traverses). The higher the degree of freedom the more likely this method will find the blunders. This method will not work if the standard least squares processing will not converge. Use the 'Preprocess the raw data' blunder detection method if the network is not converging.

First, select the number of adjustments or passes you wish to make. Each time an adjustment is completed, the measurements will be re-weighted based on the residuals and standard errors. Hopefully, after three or four passes, the blunders will become obvious. The results are shown in the ERR file, look for the measurements with the highest standard residuals. These measurements are more likely to contain blunders.

The theory behind this method is that after processing, the measurements with blunders are more likely to have higher residuals and computed standard errors. So, in the next pass the measurements are reweighted based on the computed residuals, with less weight being assigned to the measurements with high residuals. After several passes it is likely that the measurements with the blunders have been reweighed such that they have little effect on the network.

As a rule of thumb three or four passes are usually sufficient. Following is a section of the report showing the results of the 'Reweight by residuals & std. err.'. This report was generated using the same data used in the earlier example. Notice that it has flagged the same two angle measurements.

The 'Reweight by residuals & std. err.' method performs a new adjustment for each pass. So, this method will take longer than the standard least squares adjustment, but does not take near as long to complete processing as the 'Float one Observation' method for larger networks.

**Adjusted Observations**

**Adjusted Distances**

<table>
<thead>
<tr>
<th>From Sta. To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>101 2 68.778</td>
<td>-0.009</td>
<td>0.827</td>
<td>0.014</td>
<td></td>
</tr>
<tr>
<td>2 3 22.588</td>
<td>-0.010</td>
<td>0.942</td>
<td>0.015</td>
<td></td>
</tr>
<tr>
<td>3 4 47.694</td>
<td>-0.002</td>
<td>0.208</td>
<td>0.009</td>
<td></td>
</tr>
<tr>
<td>4 5 44.954</td>
<td>-0.001</td>
<td>0.077</td>
<td>0.006</td>
<td></td>
</tr>
<tr>
<td>5 6 62.608</td>
<td>0.010</td>
<td>0.919</td>
<td>0.016</td>
<td></td>
</tr>
<tr>
<td>6 7 35.517</td>
<td>0.011</td>
<td>1.040</td>
<td>0.016</td>
<td></td>
</tr>
<tr>
<td>7 101 61.705</td>
<td>0.004</td>
<td>0.398</td>
<td>0.011</td>
<td></td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.008

**Adjusted Angles**

<table>
<thead>
<tr>
<th>BS Sta. Occ. Sta. FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes. StdDev(Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>7 101 2 048-05'07&quot;</td>
<td>-4 0 21</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
101 2 3 172-13'19" -77 * 2 65
2 3 4 129-29'56" -91 * 3 64
3 4 5 166-09'44" .3 0 24
4 5 6 043-12'05" 0 0 9
5 6 7 192-11'40" -0 0 19
6 7 101 148-38'10" -1 0 20
Root Mean Square (RMS) 45

Adjusted Azimuths
Occ. Sta. FS Sta. Bearing Residual StdRes StdDev(Sec.)
101 7 N 00-00'00"E 0 0 2
Root Mean Square (RMS) 0

Statistics

Solution converged in 1 iterations
Degrees of freedom:3
Reference variance:1.77
Standard error unit Weight: +/-1.33
Passed the Chi-Square test at the 95.00 significance level
0.216 <= 5.322 <= 9.348

The blunder is most likely in the measurement containing the largest residual and standard residual

Tools Menu

**Inverse Buttons** - The 'Inverse' button is found on the main window (the button with the icon that shows a line with points at each end). You can also select the Tools->Inverse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the bearing and distance between any two points in the network. Additionally the standard deviation of the bearing and distance between the two points is displayed.

The **Relative Error Ellipse Inverse** button is found on the main window (the button with the icon that shows a line with an ellipse in the middle). You can also select the Tools > Relative Error Ellipse menu option. This feature is only active after a network has been processed successfully. This option can be used to obtain the relative error ellipse between two points. It shows the semi-major and semi-minor axis and the azimuth of the error ellipse, computed to a user-define confidence interval. This information can also be used to determine the relative precision between any two points in the network. It is the relative error ellipse calculation that is the basis for the ALTA tolerance reporting. If the 'Enable sideshots for relative error ellipses' toggle is checked then all points in the project can be used to compute relative error ellipses. The trade-off is that with large projects processing time will be increased.
If you need to certify as to the "Positional Tolerances" of your monuments, as per the ALTA Standards, use the Relative Error Ellipse inverse routine to determine these values, or use the specific ALTA tolerance reporting function as explained later in the manual.

For example, if you must certify that all monuments have a positional tolerance of no more than 0.07 feet with 50 PPM at a 95 percent confidence interval. First set the confidence interval to 95 percent in the Settings/Adjustment screen. Then process the raw data. Then you may inverse between points in as many combinations as you deem necessary and make note of the semi-major axis error values. If none of them are larger than 0.07 feet + (50PPM*distance), you have met the standards. It is however more convenient to create a Relative Error Points File containing the points you wish to check and include the ALTA tolerance report. This report takes into account the PPM and directly tells you if the positional tolerance between the selected points meets the ALTA standards.

Convert GPS/Total Station Files

The purpose of this option is to convert GPS vector files that are in the manufacturers' binary or ASCII format into the StarNet ASCII file format. The advantage of creating an ASCII file is that the ASCII file can be edited using a standard text editor. Being able to edit the vector file may be necessary in order to edit point numbers so that the point numbers in the GPS file match the point numbers in the total station file.

There is also a tool to convert Trimble Data Exchange total station data to either the Carlson RW5 format or the C&G CGR format.
The following dialog box is displayed after choosing this option.

![Convert GPS and/or Total Station Files dialog box](image)

First choose the file format of the GPS vector file to be converted. Next use the 'Select' button to navigate to the vector file to be converted. If you are converting a Thales file you have the option to remove the leading 0's from Thales point numbers. Next, use the second 'Select' button to select the name of the new ASCII GPS vector file to be created. Choose the 'Convert' button to initiate the file conversion. Press the 'Cancel' button when you have completed the conversions. The file created will have an extension of .GPS. Following are the different GPS formats that can be converted to ASCII.

**Ashtech/Thales:** The Ashtech/Thales GPS vector file is a binary file and is sometimes referred to as an 'O' file. Notice that you have the option to remove the leading 0's from Thales point numbers, by checking the "Remove leading 0's from Thales point numbers" check box.

**Carlson RW5:** Carlson SurvCE version 2.0 or higher can store GPS vectors in the RW5 raw data file. Unlike other vector files, these vectors are Antenna to Antenna so the rod height information must be obtained from the RW5 file. This allows you to edit rod heights and re-process the vectors. Additionally, RW5 vectors are always in meters, regardless of the job units.

**LandXML (.XML):** The landXML format is an industry standard format. Currently SurvNet will only import LandXML survey point records. The conversion does not currently import LandXML vectors.

**GeoLab IOB Format:** GeoLab's vector format.

**Leica:** The Leica vector file is an ASCII format typically created with the Leica SKI software. This format is created by Leica when baseline vectors are required for input into 3rd party adjustment software such as SurvNet. The SKI ASCII Baseline Vector format is an extension of the SKI ASCII Point Coordinate format.

**NGS G-File:** The NGS G-File is the format used National Geodetic Survey in their processing software.

**NGS G-File from an OPUS report:** Every OPUS report contains a G-File section. The vectors making up this G-file are the vectors from the control points to the computed point making up the OPUS solution. These OPUS vectors can be extracted and then combined with other GPS or total station data to create a larger SurvNet project. If the OPUS vector data is used in a SurvNet project it is important to use Geoid modeling since the control points making up the OPUS solution typically cover a large extents.
Topcon (.TVF): The Topcon Vector File is in ASCII format and typically has an extension of .TVF

Topcon (.XML): The Topcon XML file is an ASCII file. It contains the GPS vectors in an XML format. This format is not equivalent to LandXML format.

Trimble Data Collection (.dc): The Trimble .dc format is an ASCII file. It is typically output by Trimble’s data collector. It contains a variety of measurements including GPS vectors. This option only converts GPS vectors found in the .DC file.

Trimble Data Exchange Format (.ASC): The Trimble TDEF format is an ASCII file. It is typically output by Trimble’s office software as a means to output GPS vectors for use by 3rd party software. The Trimble Data Exchange file can also contain traverse data. The conversion dialog will give you the option to create either an RW5 or CGR file with the traverse data, along with the GPS file containing the vector data.

Trimble LandXML (*.jxl): Trimble vector files in Land XML format.

Convert Level Files

The purpose of this option is to convert differential level files from digital levels into C&G/Carlson differential level file format. At present the only level file format that can be converted are the level files downloaded from the Topcon digital levels.
The EDM Calibration program allows a surveyor to enter and process the raw data collected on an EDM calibration baseline. The purpose of an EDM calibration is to determine if the EDM is measuring within standards. The program performs a statistical analysis of that data as outlined in "Use of Calibration Base Lines", by Charles J. Fronczek, NOAA Technical Memorandum NOS NGS-10. The NGS document can be downloaded from the NGS website. NGS maintains a webpage on EDM Calibration Base Lines. The manual and other information on EDM calibrations can be found at http://geodesy.noaa.gov/CBLINES/calibration.shtml. Following is the main EDM Calibration dialog box. NGS publishes the EDM calibration data in metric units. SurvNet's EDM calibration program currently expects the data to be collected in meters.

The basic flow of this program is to first fill out the lower portion of the dialog box which contains different text fields, EDM constant values, and the optional Atmospheric Corrections settings. Next, fill out the grid in the upper portion of the dialog box. This grid contains the field data collected and also the published distances between monuments of the baseline. After this information has been filled out use the 'Compute' button The program will then display the result of the calibration in the window in the lower portion of the dialog box as follows.
After the file is processed the results can be stored as an ASCII text file. Use the 'Save Output' or the menu option "File/Save Results File As..." to save the results. First, you will be prompted for an output file name. The input data can also be stored. Once stored it can be opened and processed again.

Following is the entire output with a brief explanation of the results. Comments about the results are inserted in bold.

EDM Calibration Report

Observed Data

EDM Type:  
Date:  
Time:  
Prism description:  
Weather description:  
Comment:  
Atmosphere Correction: OFF

Constants: Reflector: 0.000  EDM: 0.000

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>From Elev.</th>
<th>From HI</th>
<th>To Sta.</th>
<th>To Elev.</th>
<th>To HI</th>
<th>Temp.</th>
<th>Pressure</th>
<th>Slope Dist.</th>
<th>Published Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td>STA_0</td>
<td>47.494</td>
<td>1.576</td>
<td>STA_150</td>
<td>44.631</td>
<td>1.552</td>
<td>0.0</td>
<td>0.0</td>
<td>150.0326</td>
<td>150.0008</td>
</tr>
<tr>
<td>STA_0</td>
<td>47.494</td>
<td>1.576</td>
<td>STA_400</td>
<td>41.497</td>
<td>1.537</td>
<td>0.0</td>
<td>0.0</td>
<td>400.0229</td>
<td>399.9772</td>
</tr>
<tr>
<td>STA_0</td>
<td>47.494</td>
<td>1.576</td>
<td>STA_1100</td>
<td>41.431</td>
<td>1.519</td>
<td>0.0</td>
<td>0.0</td>
<td>1100.0203</td>
<td>1100.0001</td>
</tr>
<tr>
<td>STA_150</td>
<td>44.631</td>
<td>1.570</td>
<td>STA_1100</td>
<td>41.431</td>
<td>1.519</td>
<td>0.0</td>
<td>0.0</td>
<td>950.0081</td>
<td>949.9991</td>
</tr>
<tr>
<td>STA_400</td>
<td>41.497</td>
<td>1.583</td>
<td>STA_1100</td>
<td>41.431</td>
<td>1.519</td>
<td>0.0</td>
<td>0.0</td>
<td>700.0265</td>
<td>700.0226</td>
</tr>
<tr>
<td>STA_400</td>
<td>41.497</td>
<td>1.580</td>
<td>STA_150</td>
<td>44.631</td>
<td>1.480</td>
<td>0.0</td>
<td>0.0</td>
<td>249.9946</td>
<td>249.9764</td>
</tr>
<tr>
<td>STA_400</td>
<td>41.497</td>
<td>1.580</td>
<td>STA_0</td>
<td>47.494</td>
<td>1.526</td>
<td>0.0</td>
<td>0.0</td>
<td>400.0260</td>
<td>399.9722</td>
</tr>
</tbody>
</table>

The above section shows the input. The input consists of the observed slope distances and the measured HI’s. The from and To elevations are published data from the data sheet from NGS on the particular baseline being...
observed. The published distances are also published data from the data sheet from NGS. In this example atmospheric pressure was turned off so the temperature and Pressure fields are irrelevant.

Results

Null Hypothesis, \( H_0 \): EDM scale error and EDM constant error = 0.0

If the scale error and the EDM constant are 0.0 then the edm is without error. So the purpose of the statistical test is to test how close to 0.0 are the results.

Scale Error (ppm): -0.00000044
Constant Error: -0.0032

The two above lines show the values for the computed scale error and constant error.

Scale Standard Error: 0.00000403
Constant Standard Error: 0.0026

The two above lines show the values for the computed standard errors of the scale error and constant error.

Reference Variance: 0.0000126
Scale t-Value: -0.1096
Constant t-Value: -1.2110
Degrees of Freedom: 5
Critical t-Value at the 1 percent confidence level: 4.0320
Cannot reject the \( H_0 \) for the scale error. (The scale factor is 0.0)
Cannot reject the \( H_0 \) for the constant error. (The constant is 0.0)

The above lines show the final results of the statistical test. Since the test determined that we cannot reject the null hypothesis, this edm is in good working order.

EDM Calibrations and Atmospheric Corrections

The atmospheric correction algorithms used in the edm calibration are from the NGS manual. To use this method both dry-bulb and wet-bulb temperature needs to be measured, or the vapor pressure, \( e \), and the dry bulb temperature needs to be measured. Refer to the NGS documentation for a detailed explanation of the atmospheric corrections that they use.
It is probably most common to turn atmospheric correction off in the calibration program, and turn atmospheric correction ON on the EDM (total station). When atmospheric correction is turned off in the calibration program the user does not need to enter the temperature into the grid or any of the other atmospheric values. If atmospheric corrections are turned OFF then the grid input columns 'Temp. (dry bulb)', 'Pressure, (mm of Hg)', and 'Temp. (wet bulb)' will not be displayed since they are not needed.

Constants can be entered for both the EDM and the reflector. These values are added to the observed distances during processing. Typically they are set to 0.0.

The following text fields have no effect on any computations and are simply comments that can be used to document the calibration.

**Entering Data Into the EDM Calibration Grid**

Blank data records are inserted into or deleted from the grid using the following tool bar.

The first button deletes the current highlighted record. The second button inserts a new blank record before the current highlighted record. The third button inserts a new blank record after the current highlighted record.
Alternately the 'Edit' menu options could be used to delete and insert new data records.

Following is a brief explanation of the fields that make up the grid.

From Sta. - This field represents the station name where the EDM is located. Any name can be used, but you must be consistent and used the same name whenever you occupy or measure a distance to the station.

From HI. - This field represents the height of instrument of the from station. It should be in the same units as the measurements. If horizontal distances are being entered into the grid then all the HI fields should be set to a constant value such as 0.0.

From Elev. - This field represents the elevation of the station. This value is published as part of the baseline calibration sheets obtained from NGS. If horizontal distances then all the Elevation fields should be set to a constant.

To Sta. - This field represents the station name where the prism is located. Any name can be used, but you must be consistent and used the same name whenever you occupy or measure a distance to the station.

To HI. - This field represents the height of instrument of the to station. It should be in the same units as the distance measurements. If horizontal distances are being entered into the grid then all the HI fields can be set to a constant value such as 0.0.

To Elev. - This field represents the elevation of the station where the prism is located. This value is published as part of the baseline calibration sheets obtained from NGS. If horizontal distances then all the Elevation fields should be set to a constant.

Observed S. Dist. This is the measured slope distance. This can be a measured horizontal distance. If it is a horizontal distance then all the HI’s and elevations should be set to a constant value.

Published Dist. This field represents the published distance between the From and To station. This value is published as part of the baseline calibration data obtained from NGS for the particular baseline being observed.

Temp. (dry bulb) This field is only present if atmospheric corrections are turned on.
Temp. (wet bulb) This field is only present if atmospheric corrections are turned on.

Pressure. (mm of Hg) This field is only present if atmospheric corrections are turned on.

**Edit Output Files**

You can edit any of the output files created by SurvNET processing:
- Report File (.RPT)
- NEZ File (.NEZ - ASCII coordinate file)
- Formatted NEZ File (.OUT - ASCII coordinate file)
- Error File (.ERR) - file containing list of processing errors.

SurvNET will use Microsoft Notepad as the editor.

**Edit Level Files**

If you have a .TLV or .LEV level file in your project, this option will run the Carlson Level Editor program and automatically load the level file for editing.

**View Menu**

**Graphics**

SurvNet provides a window that graphically displays the survey network. Additionally the user is able to display error ellipses, and GPS vectors. The user has much control over how the network is displayed. The graphic tool is a useful tool in debugging networks since the raw data can be displayed prior to adjustment. If there are problems with the raw data the graphics often reflect the problem. The actual graphics cannot be output or saved. The graphics can be shown independent of whether the project has been processed.

The following snapshot shows a view of the graphic window. The graphic window can be accessed using the eye icon on the main tool bar. A project must be opened before the graphic window can be displayed. The graphics window will only display error ellipses after the project has been processed.

The tool bar in the graphics window contains buttons that allow the user to pan, zoom in, zoom out, zoom extents, and zoom to a window. Additionally there is a button that allows the user to navigate to points in the .CGR raw data editor. Also, there are buttons that will refresh the graphic, and change the graphic settings.
Pan:  Use this button to pan the graphics.

Zoom in:  Use this button to zoom in on the graphics.

Zoom out:  Use this button to zoom out on the graphics.

Zoom extent:  Use this button to zoom to the extents of the graphics

Zoom to window:  Use this button to zoom to the extents of a user picked window.

Pick Point.  This button allows the user to navigate within the .CGR raw editor from the graphics window. Currently this button serves no purpose when working with .RW5 data.

Settings:  This button is used to change the graphic display settings.

Refresh:  This button will refresh the graphic view. Graphics are generated from the saved raw data file. If you make changes to the raw file in the raw editor you must save the file before the changes will be reflected in the refreshed graphic screen.

Following is a description of the options in the graphics setting dialog box, which is accessed using the tool bar button.

**Points Options**
These settings determine how the different type control points are displayed in the graphics window. Different graphic settings can be applied to standard control points, fixed control points and floating control points. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The control point name can be displayed and its size set from this setting dialog box.

The graphic pick radius defines a search radius. This radius is used when navigating the .CGR editor using the graphic window. You can pick a point graphically and the cursor in the editor will go to the next field containing that point number. The radius is defined in terms of the distance units of the raw data file.

### Trav/SS's Options

These settings determine how the network line work will be displayed for total station raw data. There are settings for traverse data, side shot data, and azimuth control. The program considers any point that has only a single angle and distance to it a side shot. The user can control the color of the traverse lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The point name can be displayed and its size set from this setting dialog box.

### Error Ellipses Options

These settings determine how the error ellipses will be displayed in the graphic window. Error ellipses will only be
The display of the error ellipses is relative. The program automatically determines a default relative error ellipse size. The user can modify the visual size of the error ellipses using the track bar in the following dialog box. The user can also control the color of the error ellipse from the following dialog box.

**GPS Options**

The settings in the following dialog box determine how GPS vectors will be displayed in the graphic window. The user can control the color of the GPS vector lines. The symbol node display can be controlled as to symbol type, symbol color, symbol size. The GPS point names can be displayed and their size set from this setting dialog box.

**Toolbars**

Many of the most commonly used functions can be accessed using the toolbar. Following is an explanation of the buttons found in the toolbar in the order they are shown.

- **Create New Project** - New project Icon.
- **Open an Existing Project** - Open file Icon.
Save the Current Project - Disk Icon.
Print One of the Reports - Printer Icon.

Settings - Wrench Icon. This icon initiates the SETTINGS->STANDARD ERRORS tab.

Data Collector Transfer Program - This icon will initiate either the C&G Data Collector Transfer/Conversion program or the Carlson SurvCom program. The C&G program allows you to transfer data from the data collector, or convert the data collector file to a .CGR file format. It supports all major data collectors. The Carlson program connects specifically to the Carlson SurvCE data collector.

Edit Raw Data - This icon can be used to start either the .RW5 raw data editor or the .CGR raw data editor. If your project has multiple raw data files, you will be shown a list and asked to select the file you wish to edit. The appropriate editor will be called depending on what type raw files are defined in the project settings. If no raw file or project has been specified the default raw editor as defined in the Settings menu will be executed. Any changes you make in the editor need to be saved before returning to SurvNet for processing.

Process Network - Icon that looks like a traverse network.
Inverse - Icon has a line with points on each end.
Relative Error Ellipses - Icon has a line with points on each end and an ellipse in the middle.
Graphics - Icon that looks like an eye. This icon is active once a project has been opened.

Help - Icon that looks like a question mark. This icon will take you to the SurvNET help feature.

Raw Traverse Data
SurvNet works equally well for both Carlson users and C&G users. The primary difference between the two users is that a Carlson user will typically be using an .RW5 file for his raw data and a C&G user will typically be using a .CGR as the source of his raw data.

SurvNet is capable of processing either C&G (.CGR) raw data files, Carlson (.RW5) raw data files or SDMS (.PRJ) raw data files. If the raw data is in another format, you can use our conversion tools to create one of the supported formats.

Measurement, coordinate, elevation and direction (Brg/Az) records are all recognized. Scale factor records in the .CGR file are not processed since SurvNet calculates the state plane scale factors automatically. The menu option 'Global Settings' displays the following dialog box. If the 'Use Carlson Utilities' is chosen then the .RW5 editor will be the default raw editor and Carlson SurvCom will be the default data collection transfer program. If the 'Use C&G Utilities' is chosen then the C&G .CGR editor will be the default raw editor and C&G's data collection transfer program will be the default data collection transfer program.
Standard errors are estimated errors that are assigned to measurements or coordinates. A standard error is an estimate of the standard deviation of a sample. A higher standard error indicates a less accurate measurement. The higher the standard error of a measurement, the less weight it will have in the adjustment process.

Although you can set default standard errors for the various types of measurements in the project settings of SurvNet, standard errors can also be placed directly into the raw data file. A standard error record inserted into a raw data file controls all the measurements following the SE record. The standard error does not change until another SE record is inserted that either changes the specific standard error, or sets the standard errors back to the project defaults. The advantage of entering standard errors into the raw file is that you can have different standard errors for the same type measurement in the same job. For example, if you used a one second total station with fixed backsights and foresights for a portion of a traverse and a 10 second total station with backsights and foresights to hand held prisms on the other portion of the traverse, you would want to assign different standard errors to reflect the different methods used to collect the data.

Make sure the SE record is placed before the measurements for which it applies.

If you do not have standard errors defined in the raw data file, the default standard errors in the project settings will be applied to the entire file.

**Carlson Raw Data Editor:**

The raw data editor can be accessed from the tool bar icon. Following is an image of the .RW5 editor. Refer to the Carlson raw editor documentation for guidance in the basic operation of the editor. The following documentation only deals with topics that are specific to the .RW5 editor and SurvNet.
You can insert or Add Standard Error records into the raw data file. Use the INSERT or ADD menu option and select Standard Errors, or pick the SE buttons on the tool bar. Use the ‘Add’ menu option to insert standard error records into the raw files.

**SEc - Control Standard Errors**

You can set standard errors for Northing, Easting, Elevation, and Azimuth using the ‘Control Standard Error’ menu option. Azimuth standard errors are entered in seconds. The North, East and Elevation standard errors affect the PT (coordinate) and EL (elevation) records.

You can hold or fix the North, East and Elevation fixed by entering a "!" symbol. You can allow the North, East and Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values. If you use an "*" symbol, the current standard error values will revert to the project default values.

North East Elevation Azim

!!! (Fix all values)

### 30.0 (Allow the N., E. & Elevation to Float)
When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as fixed or float. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records (Reference azimuths) cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

Example:

North East Elev Azim
CSE ! ! !
PT 103 1123233.23491 238477.28654 923.456
PT 204 1124789.84638 239234.56946 859.275
PT 306 1122934.25974 237258.65248 904.957
North East Elev Azim
CSE * * *
PT 478 1122784.26874 237300.75248 945.840
The first SEc record containing the ‘!’ character and sets points 103, 204, and 306 to be fixed. The last SEc record contains the ‘*’ character. It sets the standard errors for point 478 and any other points that follow to the project settings. The Azimuth standard error was left blank.

**MSE - Measurement Standard Errors**

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.

"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:

Distance Point Read V.Point V.Read PPM
MSE 0.01 3 3 3 3 5
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

**SSE - Setup Standard Errors**

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Rod Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.

"Ints Hgt" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Rod Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:

TargCtr InstCtr HI TargHgt

SSE 0.005 0.005 0.01 0.01

You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank.

If you use an "s" symbol, it will return the standard error to the project default values.

**C&G Raw Data Editor:**

You can set standard errors for control, measurements and instrument setup using the Insert->Standard Error menu option:

![C&G Raw Data Editor](image)
This will open a Standard Error dialog box:

This dialog allows you to create three types of standard error records: Control, Measurement, and Setup. You need only enter the values for the standard errors you wish to set. If a field is left blank no standard error for that value will be inserted into the raw data file.

You can hold the North, East and Elevation fixed by entering a "!" symbol (as shown above). If you want to fix a point, you can press the Set Fixed Point button and it will place a "!" symbol in each field. You can allow the North, East and Elevation to FLOAT by entering a "#" symbol. You can also assign the North, East and Elevation actual values. If you use an "*" symbol (or press the "Set Project Defaults" button), the current standard error value will return to the project default values.

In the above example, a Control Standard Error record (SEc) will be created:

Below are some sample values for control standard errors:

North East Elevation Azim
! ! ! (Fix all values)

Below are some sample values for control standard errors:

<table>
<thead>
<tr>
<th>TYPE</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Azim (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEc</td>
<td>!</td>
<td>!</td>
<td>!</td>
<td>!</td>
</tr>
<tr>
<td>C</td>
<td>43</td>
<td>1400952.01400</td>
<td>1241884.70100</td>
<td>948.17100</td>
</tr>
<tr>
<td>C</td>
<td>104</td>
<td>1401717.10000</td>
<td>244262.31000</td>
<td>976.97000</td>
</tr>
<tr>
<td>IP</td>
<td>104</td>
<td>5.140</td>
<td>103</td>
<td>6.000</td>
</tr>
</tbody>
</table>

Below are some sample values for control standard errors:

North East Elevation Azim
! ! ! (Fix all values)
When you fix a measurement, the original value does not change during the adjustment and all other measurements will be adjusted to fit the fixed measurements. If you allow a value to float, it will not be used in the actual adjustment, it will just be used to help calculate the initial coordinate values required for the adjustment process. Placing a very high or low standard error on a measurement accomplishes almost the same thing as setting a standard error as float or fixed. The primary purpose of using a float point is if SurvNet cannot compute preliminary values, a preliminary float value can be computed and entered for the point.

Direction records (reference azimuths) cannot be FIXED or FLOAT. You can assign a low standard error (or zero to fix) if you want to weight it heavily, or a high standard error to allow it to float.

**MSE - Measurement Standard Errors**

You can set the standard errors for distances, horizontal angle pointing, horizontal angle reading, vertical angle pointing, vertical angle reading, and distance constant and PPM.

"Distance" - distance constant and measurement error, can be obtained from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"PPM" - Parts per Million, obtain from EDM specs, or from performing an EDM calibration on an EDM baseline, or from other testing done by the user.

"Pointing" - total station horizontal angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves. Or you may set it higher for total stations running in Robotic Mode because they cannot point as well as a manual sighted total station.

"Reading" - total station horizontal angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

"V.Pointing" - total station vertical angular pointing error in seconds. This value is an indication of how accurately the instrument man can point to the target. For example, you may set it higher in the summer because of the heat waves.

"V.Reading" - total station vertical angular reading error in seconds. If you have a 10 second theodolite, enter a reading error of 10 seconds.

Example:
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank. If you use an "*" symbol, the standard error for that measurement type will return to the project default values.

The following SEm record will be created:

**SSE - Setup Standard Errors**

These standard errors are a measure of how accurately the instrument and target can be setup over the points.

"Targ Ctr" is the Target Centering error. This value reflects how accurately the target prism can be set up over the point.

"Inst Ctr" is the Instrument Centering error. This value reflects how accurately the instrument can be set up over the point.

"HI" is the Instrument Height error. This value reflects how accurately the height of the instrument above the mark can be measured.

"Targ Hgt" is the Target Height error. This value reflects how accurately the height of the prism above the mark can be measured.

Example:
You can enter any combination of the above values. If you do not want to change the standard error for a particular measurement type, leave it blank. If you use an "*" symbol, it will return the standard error to the project default values.

The following SEs record will be created:

There are several other features available in both the Carlson and C&G editors that are useful to SurvNet.

- **Insert Coordinate records from file** - when inputting control into a raw data file, it is more convenient to read the control point directly from a coordinate file than it is to manually key them in. The "Insert Coordinates" function allows you to select points in a variety of manner making it easy to select just control points. For example, you can select points by description, code, point blocks, point number, etc.
• **Data ON/OFF records** - when trying to track down problems, sometimes it is convenient to remove certain sections of raw data prior to processing. The editors have a special record (DO record) that will turn OFF or ON certain areas of data. For example, when you insert a DO record all data following that record will be turned OFF (it will be shown in a different color). When you insert another DO record further down, the data following it will be turn back ON. It is simply a toggle. In the example below, the instrument setup at point 106 backsighting 105 was turned OFF.
On the SurvNET toolbar, the one with the network, and eye icons, you can press the "remove data on/off" icon and all DO records will be removed from the raw data file, showing the data as it originally existed.

**Graphics and the C&G Editor** - When using the C&G editor the graphics window can be used to navigate within the raw data. To use this feature initiate the graphics window from the C&G Editor.

Press the graphic 'Pick Point' button then pick the desired point in the graphic window. The text editor cursor should move to the next record that contains that point number.
If there is more than one point number within the search radius the following dialog box is displayed so that the desired point can be chosen.

One of the benefits of least squares is the ability to process redundant measurements. In terms of total station data, redundant measurement is defined as measuring angles and/or distances to the same point from two or more different setups.

It is required that the same point number be used when locating a point that was previously recorded. However,
since some data collectors will not allow you to use the same point number if the point already exists, the following
convention for collecting redundant points while collecting the data in the field is used. If you begin the point
description with a user defined string, for example a "=" (equal sign) followed by the original point number, we will
treat that measurement as a redundant measurement to the point defined in the description field. The user defined
character or string is set in the project settings dialog. For example, if point number 56 has the description "=12", we
will treat point number 56 as a shot to point number 12, not point 56. Make sure the Preprocessing Settings dialog
box has the Pt. Number Substitution String set to the appropriate value.

Alternately, the point numbers can be edited after the raw data has been downloaded from the data collector.

**Supplemental Control Files**

In order to process a raw data file, you must have as a minimum a control point and a control azimuth, or two control
points. Control points can be inserted into the raw data file or alternately control points can be read from coordinate
files. Control points can be read from a variety of coordinate file types:

- Carlson SQLite (.CRDB)
- C&G or Carlson numeric (.CRD) files
ASCII (.NEZ) file

Typically the standard errors for the control points from a supplemental control file will be assigned from the NORTH, and EAST standard errors from the project settings dialog box. The option ‘CSV ASCII NEZ with std.’ is the exception. With this option the standard errors are field within the file.

In the ASCII .NEZ file, the coordinate records need to be in the following format:
Pt. No., Northing, Easting, Elevation, Description<cr><lf>
103, 123233.23491, 238477.28654, 923.456, Mon 56-7B<CR><LF>

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

ASCII latitude and longitude (3D model only)

In the ASCII latitude and longitude file, the records need to be in the following format:
Pt. No., Latitude (NDDD.mmssssss), Longitude (WDDD.mmssssss), Elevation (Orthometric), Description<cr><lf>
FRKN,N35.113068642,W083.234174724,649.27<CR><LF>

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

CSV ASCII NEZ with std. errors.

In the CVS ASCII .NEZ with std. errors file, the coordinate records need to be in the following format: This format is typically created as an output NEZ option. The typical use of this format is if the control for a project was initially created as a project. Then the points from that projects can be used as supplemental control for subsequent projects and the actual standard errors of the control will be used.

504, 204015.23528803, 786760.95695104, 876.15662064, 0.002, 0.003, 0.004, 1<CR><LF>

Each line is terminated with carriage-return <CR> and line-feed <LF> characters.

The major advantage of putting coordinate control points in the actual raw data file is that specific standard errors can be assigned to each control point (as described in the RAW DATA section above). If you do not include an SE record the standard error will be assigned from the NORTH, EAST, and ELEVATION standard errors from the project settings dialog box.

**Warning:** SurvNET will not allow the supplemental control file and the final output file to be the same file. This is because ALL points in the supplemental control file are treated as CONTROL. If you were allowed to output to the Control File, after you processed the data ALL the points would then be considered CONTROL the next time you process.
SurvNet Editor
Please refer to topic on Carlson or CGEditor raw editor.

Data Collector Transfer
Please refer to the Carlson or CG data collector transfer topic

Example Projects
On the installation disk there are a variety of different least squares projects one can use to become familiar with least squares and SurvNet. These projects are located in the C&G/Carlson application folder under the \Data\SurvNet\ subdirectory.

When you open a project for review, you will need to check the project settings - input data files tab to see if the data files are listed. If they are not, you will have to re-select them.

Simple Traverse with Traverse Closure
This project is located in \Data\SurvNet\2DTraverse. The name of the project is Traverse. This project illustrated a basic loop traverse with two control points and a known azimuth for control. This project also illustrates how to obtain traditional closure information as part of the least squares report. The program uses the 2D/1D model and uses a local coordinate system.

Traverse using State Plane Coordinates
This project is located in \Data\SurvNet\SPCTraverse. The name of the project is TravSPCUSFt. This project illustrated a basic network with three GPS control points for control. This project is computed using the SPC83 NC Grid coordinate system. The project is set up to generate traditional loop closure data. The program uses the 2D/1D model. No elevations are computed or adjusted as there were no HI’s or rod readings collected. Notice, that the project uses two raw data files. One file contains the raw angle & distance data. The other raw data file contains the control for the project.

Network with ALTA Reporting
The ALTA reporting project is located in \Data\SurvNet\ALTARpt. The name of the project is ALTARpt. This project illustrates how to perform ALTA tolerance testing on points within a network.

GPS Network with GPS Loop Closures
The GPS network project is located in \Data\SurvNet\GPSNetwork. The name of the project is GPSOnly. This project is a simple GPS network. In addition to the least squares computation and report, GPS loop closures were generated for various GPS loops for this project.

Level Network
The differential leveling project is located in \Data\SurvNet\LevelNetwork. The name of the project is network1. This project is a simple differential leveling network.

Basic 3D Project
The basic 3D adjustment project is located in \Data\SurvNet\3DNetwork. The name of the project is pg08. This project is a simple four point example network. Notice in the raw data that all set up records have an HI and all FS readings have valid rod heights. Also note that there are valid vertical angles for every slope distance. Since the 3D model is a true one process 3 dimensional adjustment, you must enter all valid slope distances and vertical angles. Be aware that you cannot just enter a horizontal distance and a vertical angle of 90 from reduced field notes when adjusting using the 3D model.

### 3D Project Combining Total Station and GPS Vectors

The total station raw data combined with GPS vectors example is located in \Data\SurvNet\GPSandTtlSta. The name of the project is GPSandTtlSta. This project illustrates a 3D model adjustment that combines both GPS vectors and data from a total station. Since there is GPS data the 3D model must be used. Notice that the GPS vectors are in meters but the total station data is in US feet and the output coordinates are in US feet. Always make sure your units are correct for each data type especially when using the 3D model.

### Resection

The total station raw data combined with GPS vectors example is located in \Data\SurvNet\Resection. The name of the project is Resect. This project illustrates an angle and distance resection. There is no real difference in a resection project than any other angle and distance network in terms of how the data is collected or how the project is set up.

### Network Processing Reports

**Report File:** A report file consisting of the project name with an .RPT extension is generated after successfully processing the raw data. The report file will be shown in a text window so you can analyze the data. You can pick the "Printer" icon if you want a hardcopy. The following sections review some example results from several different types of adjustments.

### 2D-1D Local Coordinate System

The following explanations should be used in conjunction with the report at the end of the explanatory text.

#### Project Settings

The first section of the report displays the project settings at the time the project was processed.

#### Tolerances

The second section of the report displays warning and error messages generated during the preprocessing of the raw data. The primary messages displayed will be warnings when multiple angles, horizontal distances, and vertical differences exceed the tolerance settings as set in the project settings. The low and high measurement and the difference are displayed. It is prudent to pay attention to any messages generated in this section of the report. Some warnings may be innocuous but it is prudent to check and understand all warning messages.

#### Unadjusted Observations

The next four sections list the reduced and averaged, but unadjusted measurements that make up the network. Multiple measurements of the same angle or distance are averaged to a single measurement. The standard error of multiple averaged measurements is less than the standard error of a single measurement. When multiple measurements are used, the standard error for the averaged measurement will be computed using the average of the mean formula.
The first of the four sections is a list of the control coordinates used in the network adjustment. These coordinates could have been read from the .CGR raw data file, or from the .CRD or .NEZ supplemental coordinate file. Notice that the standard errors for the control points are displayed.

The second of the four measurement sections shows the distances and distance standard errors used in the adjustment. These distances are horizontal distances computed from all slope distance and vertical angles for that distance, including all foresight and backsight distances. The standard error settings used to calculate the final distance standard error include the distance standard error, the PPM standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final distance standard error are found in section 6.12 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The third of the four measurement sections shows the angles and angle standard errors used in the adjustment. These angles are the averaged angle value for all the multiple angles collected. The standard error settings used to calculate the final angle standard error include the pointing standard error, the reading standard error, the target centering standard error and the instrument centering standard errors. The techniques and formulas used to calculate the final angle standard error are found in section 6.2 of the textbook "Adjustment Computations, Statistics and Least Squares in Surveying and GIS", by Paul Wolf and Charles Ghilani.

The fourth of the four measurement sections shows the azimuths and azimuth standard errors used in the adjustment. Azimuths can only be defined as a direction record in the .CGR raw data file.

### Adjusted Coordinates

If the adjustment of the network converges the next section displays a list of the final adjusted coordinates and the computed standard X, Y standard error. An interpretation of the meaning of the X, Y standard error, is that there is a 68% probability that the adjusted X, Y is within plus or minus the standard error of the X, Y of its true value.

The next section displays the error ellipses for the adjusted coordinates. The error ellipse is a truer representation of the error of the point than the X, Y standard error. The error ellipses are calculated to the confidence interval as defined in the settings screen. In this report the error ellipse axis is larger than the X, Y standard errors since the error ellipses in this report are calculated at a 95% probability level as set in the Settings screens. The maximum error axis direction is along the axis of the semi-major axis. The direction of the minimum error axis direction is along the semi-minor axis and is perpendicular to the semi-major axis. If a point is located from a variety of stations, you will most likely see that the error ellipse will approach a circle, which is the strongest geometric shape.

### Adjusted Observations

The next three sections list the adjusted horizontal distance, horizontal angle, and azimuth measurements. In addition to the adjusted measurement the, residual, the standard residual and the standard deviation of the adjusted measurement is displayed.

The residual is defined as the difference between the unadjusted measurement and the adjusted measurement. The residual is one of the most useful and intuitive measures displayed in the report. Large residuals in relation to the standards of the survey are indications of problems with the data.

The standard residual is the a priori standard error divided by the residual of a measurement. The a priori standard errors are the standard errors of the measurements as displayed in the unadjusted measurement section. A standard residual of 1 indicates that the adjustment applied to the measurement is consistent with the expected adjustment to the measurement. One or a few measurements having high standard residuals, in relation to the rest of the standard residuals, may be an indication of a blunder in the survey. When all standard residuals are consistently large there is likely an inconsistency in the a priori standard errors and the adjustments being made to the measurements. In other words the standard errors defined for the project are too small, in relation to the survey methods used.

The standard deviation of the measurement means that there is a 68% probability that the adjusted measurement is within plus or minus the standard deviation of the measurement's true value.

Additionally, the root mean square of each measurement type is displayed. The root mean square is defined as the square root of the average of the squares of a set of numbers. Loosely defined, it is as an average residual for that measurement type.
Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not an individual measurement. A value of one indicates that the results of the adjustment are consistent with a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data (.CGR) file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the final adjusted coordinates may change very little.

Sideshots

The next section displays the computed sideshots of the network. Sideshots are filtered out of the network adjustment as part of the preprocessing process if the 'Enable Sideshots for Error Ellipses' toggle is off. Least squares adjustment requires a lot of computer resources. Sideshots are filtered out to minimize the computer resources needed in a large network adjustment. The sideshots are computed from the final adjusted network points. The results of the side shot computations are the same whether they are reduced as part of the least squares adjustment or from the final adjusted coordinates.

VERTICAL ADJUSTMENT REPORT

The next part of the report displays the results of the vertical adjustment. In the 2D/1D model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network will also be reduced and adjusted using least squares.

The first section displays the vertical benchmarks used in the vertical adjustment. Next, is listed the points that will be adjusted as part of the vertical adjustment. The following section displays the measurements used in the adjustment. The measurements consist of the vertical elevation difference between points in vertical adjustment. The lengths between these points are used to determine the weights in the vertical adjustment. Longer length lines are weighted less in the vertical adjustment than shorter length lines.

The next section displays some statistics about the vertical control: Number of unknown elevations, number of routes, number of fixed and non-fixed benchmarks, and degrees of freedom.

The next section displays the adjusted elevations and the computed standard deviations of the computed elevations. Following the adjusted elevation section is a section displaying the final adjusted elevation difference measurements and their residuals. Finally, the computed side shot elevations are displayed.

State Plane Reduction Report file:

When reducing to a state plane coordinate system, there is additional information displayed in the report file.

First, notice the heading of the report. The heading indicates that the project is being reduced into the North Carolina zone of the 1983 State Plane Coordinate System. The heading shows that the elevation factor is computed based on a project elevation of 250 feet:

================================================
LEAST SQUARES ADJUSTMENT REPORT
================================================
Mon May 08 10:16:16 2006
2D Geodetic Model.
Input Raw Files:
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.002000
Local Coordinate System, Scale Factor: 1.000000
Horizontal Units: US Feet
Confidence Interval: 95.00
Default Standard Errors:
Distance: Constant 0.010 , PPM: 5.000
Horiz. Angle: Pointing 3.0'' , Reading: 3.0''
Vert. Angle: Pointing 3.0'' , Reading: 3.0''
Total Station: Centering 0.005 , Height: 0.010
Target: Centering 0.005 , Height: 0.010
Azimuth: 5''
Coordinate Control: N:0.010, E:0.010, Z:0.030,

Horizontal Angle spread exceeds tolerance:
IP: 1, BS: 5, FS: 2
Low: 109-19'10.0'' , High: 109-19'17.0'' , Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
IP: 2, BS: 1, FS: 6
Low: 190-32'02.0'' , High: 190-32'10.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 2, BS: 1, FS: 3
Low: 096-03'48.0'' , High: 096-03'56.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 3, BS: 2, FS: 4
Low: 124-03'50.0'' , High: 124-03'56.0'' , Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
IP: 5, BS: 4, FS: 10
Low: 039-26'35.0'' , High: 039-26'45.0'' , Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
IP: 10, BS: 5, FS: 11
Low: 241-56'23.0'' , High: 241-56'35.0'' , Diff: 000-00'12.0''

Horizontal Angle spread exceeds tolerance:
IP: 11, BS: 10, FS: 12
Low: 114-56'20.0'' , High: 114-56'34.0'' , Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
IP: 12, BS: 11, FS: 3
Low: 140-39'18.0'' , High: 140-39'31.0'' , Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
IP: 5, BS: 4, FS: 1
Low: 117-30'35.0'' , High: 117-30'50.0'' , Diff: 000-00'15.0''
Horizontal Distance from 2 to 3 exceeds tolerance:
Low: 324.15, High: 324.20, Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
Low: 6.62, High: 8.36, Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
Low: 11.46, High: 11.51, Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
Low: 144.64, High: 144.66, Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT

Unadjusted Observations

Control Coordinates: 1 Observed Points, 0 Fixed Points, 0 Approx. Points
Sta. N: E: StErr N: StErr E:
1 658428.26 2150182.70 0.01 0.01

Distances: 14 Observations
From Sta. To Sta. Dist. StErr
1 5 290.45 0.01
1 2 292.21 0.01
2 6 52.39 0.01
2 3 324.19 0.01
3 4 275.60 0.01
3 20 134.66 0.01
20 21 116.07 0.01
21 22 50.12 0.01
4 5 309.65 0.01
5 10 129.99 0.01
10 11 126.01 0.01
10 15 10.00 0.01
11 12 129.43 0.01
12 3 144.65 0.01

Angles: 15 Observations
BS Sta. Occ. Sta. FS Sta. Angle StErr (Sec.)
5 1 2 109-19'13.5'' 7.7
1 2 6 190-32'06.0'' 26.2
1 2 3 096-03'52.0'' 7.3
2 3 4 124-03'53.0'' 7.8
2 3 20 185-23'56.0'' 12.8
3 20 21 180-15'26.0'' 17.6
20 21 22 183-26'45.0'' 31.2
3 4 5 093-02'11.5'' 7.5
4 5 10 039-26'40.0'' 10.4
5 10 11 241-56'29.0'' 15.6
5 10 15 056-23'10.0'' 125.0
10 11 12 114-56'27.0'' 15.5
11 12 3 140-39'24.5'' 15.3

Chapter 3. Survey Module
12 3 2 325-54'30.0'' 9.5
4 5 1 117-30'42.5'' 7.7

Azimuths: 1 Observations
Occ. Sta. FS Sta. Bearing StErr (Sec.)
1 2 N 45-00'00.0''E 5.0

Adjusted Coordinates
=====================

Adjusted Local Coordinates
Sta. N: E: StErr N: StErr E:
1 658428.26 2150182.70 0.02 0.02
2 658634.88 2150389.32 0.02 0.02
5 658554.12 2149920.92 0.03 0.02
3 658887.03 2150185.59 0.02 0.03
4 658863.61 2149910.99 0.03 0.03
20 658999.28 2150111.19 0.03 0.04
21 659096.31 2150047.49 0.04 0.05
10 658657.11 2150000.25 0.03 0.03
11 658636.21 2150124.52 0.03 0.03
12 658742.89 2150197.81 0.03 0.03

Adjusted Coordinates Error Ellipses, 95% CI
Sta. Semi Major Semi Minor Max. Error Az.
Axis Axis
1 0.05 0.05 S 29-26'39.4''E
2 0.07 0.07 N 45-00'00.0''E
5 0.08 0.07 N 10-58'28.2''E
3 0.10 0.07 N 84-37'31.0''E
4 0.11 0.07 N 51-23'12.0''E
20 0.13 0.10 N 84-24'17.5''E
21 0.17 0.12 N 72-01'17.5''E
10 0.09 0.07 N 43-35'54.5''E
11 0.09 0.08 N 54-43'51.1''E
12 0.08 0.08 N 79-48'07.2''E

Adjusted Observations
=======================

Adjusted Distances
From Sta. To Sta. Distance Residual StdRes. StdDev
1 5 290.46 0.01 1.42 0.01
1 2 292.21 -0.00 0.40 0.01
2 3 324.17 -0.01 1.62 0.01
3 4 275.59 -0.01 1.11 0.01
3 20 134.66 -0.00 0.00 0.02
20 21 116.07 -0.00 0.00 0.02
4 5 309.65 0.01 0.64 0.01
5 10 130.00 0.01 0.97 0.01
10 11 126.01 0.00 0.16 0.01
11 12 129.44 0.01 0.98 0.02
12 3 144.66 0.01 0.94 0.02
Root Mean Square (RMS) 0.01
Adjusted Angles
BS Sta. Occ. Sta. FS Sta. Angle Residual StdRes StdDev(Sec.)
5 1 2 109-19'19.2'' 5.7 0.7 9.9
1 2 3 096-03'43.4'' -8.6 1.2 9.2
2 3 4 124-03'48.1'' -4.9 0.6 10.1
2 3 20 185-23'56.0'' -0.0 0.0 21.5
3 20 21 180-15'26.0'' 0.0 0.0 29.7
3 4 5 093-02'12.8'' 1.3 0.2 9.3
4 5 10 039-26'37.1'' -2.9 0.3 14.4
5 10 11 241-56'27.5'' -1.5 0.1 21.2
10 11 12 114-56'39.8'' 12.8 0.8 21.8
11 12 3 140-39'40.8'' 16.3 1.1 20.3
12 3 2 325-54'33.8'' 3.8 0.4 13.2
4 5 1 117-30'56.6'' 14.1 1.8 9.9
Root Mean Square (RMS) 8.1

Adjusted Azimuths
Occ. Sta. FS Sta. Bearing Residual StdRes StdDev(Sec.)
1 2 N 45-00'00.0''E 0.0 0.0 8.4
Root Mean Square (RMS) 0.0

Statistics
---------------
Solution converged in 2 iterations
Degrees of freedom: 6
Reference variance: 2.84
Standard error unit Weight: +/-1.68
Failed the Chi-Square test at the 95.00 significance level
1.237 <= 17.023 <= 14.449

Sideshots
---------
From To Bearing Dist. N E StDev. N StDev. E
2 6 N 55-32'06.0''E 52.39 658664.53 2150432.52 0.02 0.02
21 22 N 29-50'09.6''W 50.12 659139.78 2150022.56 0.04 0.05
10 15 N 86-00'28.6''W 10.00 658657.80 2149990.27 0.03 0.03

LEAST SQUARES VERTICAL ADJUSTMENT REPORT
Mon May 08 10:16:16 2006
2D Geodetic Model.
Input Raw Files:
C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

VERTICAL BENCHMARKS
Station Elevation Std. Error
1 569.8500 FIXED

POINTS TO BE ADJUSTED
Station
2,5,3,4,10,11,12

Chapter 3. Survey Module
MEASUREMENT SUMMARY

From To Elev. Diff. StdErr
(unadjusted)
1 5 7.5040 0.0162
1 2 7.5659 0.0163
2 3 6.9843 0.0162
3 4 -11.4907 0.0161
4 5 4.3557 0.0165
5 10 2.2639 0.0150
10 11 1.0931 0.0150
11 12 0.3828 0.0150
12 3 3.3590 0.0153

STATISTICAL SUMMARY
Total Unknown Elevations: 7
Total Elev. Routes: 9
Total Fixed BM's: 1
Total non-fixed BM's: 0
Degrees of freedom: 2

ADJUSTED ELEVATIONS
Station Adjusted Elev Standard Dev.
2 577.4336 0.02463
5 577.3363 0.02462
3 584.4355 0.02907
4 572.9625 0.03072
10 579.6004 0.03286
11 580.6935 0.03575
12 581.0764 0.03469

ADJUSTED MEASUREMENT SUMMARY

From To Elev. Diff. Residuals Std. Dev.
(adjusted)
1 5 7.4863 -0.0177 0.025
1 2 7.5836 0.0177 0.025
2 3 7.0019 0.0177 0.025
3 4 -11.4730 0.0177 0.024
4 5 4.3738 0.0181 0.024
5 10 2.2641 0.0001 0.024
10 11 1.0932 0.0001 0.024
11 12 0.3829 0.0001 0.024
12 3 3.3591 0.0001 0.025

Vertical Sideshots
Station Elevation
7 577.6338
20 571.7662
21 581.2509
22 580.1399
15 579.6004
2D-1D State Plane Coordinate System

Note: highlighted explanatory text is found within the report text.

LEAST SQUARES ADJUSTMENT REPORT

Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files: C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON
Maximum iterations: 10 , Convergence Limit: 0.002000
1983 State Plane Coordinates, zone:3200 North Carolina
Elevation factor computed from project elevation,250.000000.
Elevation Units: US Feet
Horizontal Units: US Feet
Confidence Interval: 95.00
Project Geoid Height: 0.00
Default Standard Errors:
Distance: Constant 0.010 , PPM: 5.000
Horiz. Angle: Pointing 3.0' , Reading: 3.0'
Vert. Angle: Pointing 3.0' , Reading: 3.0'
Total Station: Centering 0.005 , Height: 0.010
Target: Centering 0.005 , Height: 0.010
Azimuth: 5'
Coordinate Control: N:0.010, E:0.010, Z:0.030,

Horizontal Angle spread exceeds tolerance:
IP: 1, BS: 5, FS: 2
Low: 109-19'10.0'' , High: 109-19'17.0'' , Diff: 000-00'07.0''

Horizontal Angle spread exceeds tolerance:
IP: 2, BS: 1, FS: 6
Low: 190-32'02.0'' , High: 190-32'10.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 2, BS: 1, FS: 3
Low: 096-03'48.0'' , High: 096-03'56.0'' , Diff: 000-00'08.0''

Horizontal Angle spread exceeds tolerance:
IP: 3, BS: 2, FS: 4
Low: 124-03'50.0'' , High: 124-03'56.0'' , Diff: 000-00'06.0''

Horizontal Angle spread exceeds tolerance:
IP: 5, BS: 4, FS: 10
Low: 039-26'35.0'' , High: 039-26'45.0'' , Diff: 000-00'10.0''

Horizontal Angle spread exceeds tolerance:
IP: 10, BS: 5, FS: 11
Low: 241-56'23.0'' , High: 241-56'35.0'' , Diff: 000-00'12.0''

Chapter 3. Survey Module
Horizontal Angle spread exceeds tolerance:
IP: 11, BS: 10, FS: 12
Low: 114-56'20.0'', High: 114-56'34.0'', Diff: 000-00'14.0''

Horizontal Angle spread exceeds tolerance:
IP: 12, BS: 11, FS: 3
Low: 140-39'18.0'', High: 140-39'31.0'', Diff: 000-00'13.0''

Horizontal Angle spread exceeds tolerance:
IP: 5, BS: 4, FS: 1
Low: 117-30'35.0'', High: 117-30'50.0'', Diff: 000-00'15.0''

Horizontal Distance from 2 to 3 exceeds tolerance:
Low: 324.15, High: 324.20, Diff: 0.04

Vertical Distance from 2 to 3 exceeds tolerance:
Low: 6.62, High: 8.36, Diff: 1.74

Vertical Distance from 3 to 4 exceeds tolerance:
Low: 11.46, High: 11.51, Diff: 0.05

Horizontal Distance from 12 to 3 exceeds tolerance:
Low: 144.64, High: 144.66, Diff: 0.02

HORIZONTAL ADJUSTMENT REPORT
================================
Unadjusted Observations
================================
Control Coordinates: 1 Observed Points, 0 Fixed Points, 0 Approx. Points
Sta. N: E: StErr N: StErr E:
1 658428.26 2150182.70 0.01 0.01

The first distance listing in the Unadjusted Observation section of the report shows the unadjusted horizontal ground distances

Distances: 14 Observations
From Sta. To Sta. Ground Dist. StErr
1 5 290.45 0.01
1 2 292.21 0.01
2 6 52.39 0.01
2 3 324.19 0.01
3 4 275.60 0.01
3 20 134.66 0.01
20 21 116.07 0.01
21 22 50.12 0.01
4 5 309.65 0.01
5 10 129.99 0.01
10 11 126.01 0.01
10 15 10.00 0.01
11 12 129.43 0.01
12 3 144.65 0.01

Angles: 15 Observations

Chapter 3. Survey Module
BS Sta. Occ. Sta. FS Sta. Angle StErr (Sec.)
5 1 2 109-19'13.5" 7.7
1 2 6 190-32'06.0" 26.2
1 2 3 096-03'52.0" 7.3
2 3 4 124-03'53.0" 7.8
2 3 20 185-23'56.0" 12.8
3 20 21 180-15'26.0" 17.6
20 21 22 183-26'45.0" 31.2
3 4 5 093-02'11.5" 7.5
4 5 10 039-26'40.0" 10.4
5 10 11 241-56'29.0" 15.6
5 10 15 056-23'10.0" 125.0
10 11 12 114-56'27.0" 15.5
11 12 3 140-39'24.5" 15.3
12 3 2 325-54'30.0" 9.5
4 5 1 117-30'42.5" 7.7

Grid Azimuths: 1 Observations
Occ. Sta. FS Sta. Bearing StErr (Sec.)
1 2 N 45-00'00.0"E 5.0

There is a new section displaying the reduced unadjusted grid distances. The grid factor, the elevation factor, and the combined factor used to reduce the ground distance to a grid distance are included in the listing:

Grid Distances: 14 Observations
From Sta. To Sta. Grid Dist. Grid Factor Z Factor Combined Factor
1 5 290.41 0.99988685 0.99998804 0.99987490
1 2 292.18 0.99988686 0.99998804 0.99987491
2 6 52.38 0.99988689 0.99998804 0.99987494
2 3 324.15 0.99988692 0.99998804 0.99987497
3 4 275.57 0.99988695 0.99998804 0.99987500
3 20 134.65 0.99988697 0.99998804 0.99987501
20 21 116.06 0.99988700 0.99998804 0.99987504
21 22 50.11 0.99988701 0.99998804 0.99987506
4 5 309.61 0.99988691 0.99998804 0.99987495
5 10 129.97 0.99988688 0.99998804 0.99987493
10 11 125.99 0.99988689 0.99998804 0.99987494
10 15 10.00 0.99988690 0.99998804 0.99987494
11 12 129.41 0.99988690 0.99998804 0.99987495
12 3 144.63 0.99988694 0.99998804 0.99987498

Average Combined Scale Factor: 0.99987497

There is a new section displaying the reduced unadjusted horizontal angles with the t-T correction applied. The t-T correction is generally a small correction. For most surveys of limited size the correction is negligible. The t-T correction is displayed in seconds:

Grid Horizontal Angles: 15 Observations
BS Sta. Occ. Sta. FS Sta. Angle StErr (Sec.) t-T
5 1 2 109-19'13.5" 7.7 0.0
1 2 6 190-32'06.0" 26.2 0.0
1 2 3 096-03'52.0" 7.3 0.0
2 3 4 124-03'53.0" 7.8 -0.0
In the Adjusted Coordinates section of the report there is a new section displaying the latitude and longitude of the final adjusted points. Additionally the convergence angle, the grid factor, the elevation factor, and the combined factor are displayed for each point:

Adjusted Geographic Coordinates
1 35-33'29.13143''N 78-29'42.16576''E 000-17'29.2'' 0.99988684 0.99998804 0.99987488
2 35-33'31.16445''N 78-29'39.62376''E 000-17'30.7'' 0.99988689 0.99998804 0.99987493
5 35-33'30.38930''N 78-29'45.32617''E 000-17'27.4'' 0.99988687 0.99998804 0.99987491
3 35-33'33.66835''N 78-29'42.10255''E 000-17'29.2'' 0.99988695 0.99998804 0.99987500
4 35-33'33.45055''N 78-29'45.42733''E 000-17'27.3'' 0.99988695 0.99998804 0.99987499
20 35-33'34.78212''N 78-29'42.99610''E 000-17'28.7'' 0.99988698 0.99998804 0.99987503
21 35-33'37.44955''N 78-29'43.76102''E 000-17'28.3'' 0.99988701 0.99998804 0.99987505
10 35-33'31.40380''N 78-29'44.35979''E 000-17'27.9'' 0.99988690 0.99998804 0.99987496
11 35-33'31.19087''N 78-29'42.85714''E 000-17'28.8'' 0.99988689 0.99998804 0.99987493
12 35-33'32.42222''N 78-29'41.96349''E 000-17'29.3'' 0.99988692 0.99998804 0.99987496

Adjusted Coordinates Error Ellipses, 95% CI
Sta. Semi Major Semi Minor Max. Error Az.
Axis Axis
1 0.05 0.05 N 17-17'30.9"E
2 0.07 0.07 N 45-00'00.0"E
5 0.08 0.07 N 10-58'14.5"E
3 0.10 0.07 N 84-37'33.3"E
4 0.11 0.07 N 51-23'11.9"E
20 0.13 0.10 N 84-24'34.6"E
21 0.17 0.12 N 72-01'28.4"E
Adjusted Observations
============================

Adjusted Distances
From Sta. To Sta. Distance Residual StdRes. StdDev
1 5 290.43 0.01 1.42 0.01
1 2 292.17 -0.00 0.40 0.01
2 3 324.13 -0.01 1.62 0.01
3 4 275.56 -0.01 1.11 0.01
3 20 134.65 0.00 0.00 0.02
20 21 116.06 0.00 0.00 0.02
4 5 309.61 0.01 0.64 0.01
5 10 129.98 0.01 0.97 0.01
10 11 126.00 0.00 0.16 0.01
11 12 129.42 0.01 0.98 0.02
12 3 144.64 0.01 0.94 0.02
Root Mean Square (RMS) 0.01

Adjusted Angles
BS Sta. Occ. Sta. FS Sta. Angle Residual StdRes StdDev(Sec.)
5 1 2 109-19'19.2'' 5.7 0.7 9.9
1 2 3 096-03'43.4'' -8.6 1.2 9.2
2 3 4 124-03'48.1'' -4.9 0.6 10.1
2 3 20 185-23'56.0'' -0.0 0.0 21.5
3 20 21 180-15'26.0'' -0.0 0.0 29.7
3 4 5 093-02'12.8'' 1.2 0.2 9.3
4 5 10 039-26'37.2'' -2.8 0.3 14.4
5 10 11 241-56'27.5'' -1.5 0.1 21.2
10 11 12 114-56'39.8'' 12.9 0.8 21.8
11 12 3 140-39'40.8'' 16.3 1.1 20.3
12 3 2 325-54'33.8'' 3.8 0.4 13.2
4 5 1 117-30'56.6'' 14.1 1.8 9.9
Root Mean Square (RMS) 8.1

Adjusted Azimuths
Occ. Sta. FS Sta. Bearing Residual StdRes StdDev(Sec.)
1 2 N 45-00'00.0''E -0.0 0.0 8.4
Root Mean Square (RMS) 0.0

Statistics
==========
Solution converged in 2 iterations
Degrees of freedom: 6
Reference variance: 2.84
Standard error unit Weight: +/-1.69
Failed the Chi-Square test at the 95.00 significance level
1.237 <= 17.037 <= 14.449

Sidestrons
==========
From To Bearing Dist. N E StDev. N StDev. E
2 6 N 55-32'06.0''E 52.38 658664.50 2150432.48 0.02 0.02
GPS Network

Note: The following section shows the report generated by the least squares adjustment of the GPS network. Explanations of the report are included in the report section and are in bold text.

==========================================
LEAST SQUARES ADJUSTMENT REPORT
==========================================

Mon May 08 13:03:02 2006
3D Geodetic Model.
Input Raw Files: C:\data\lsdata\3dModel\gpsOnly\control.cgr
GPS File: C:\data\lsdata\3dModel\gpsOnly\chapt16.gps

Output File: C:\data\lsdata\3dModel\gpsOnly\gpsOnly1.RPT
Traverse File: C:\data\lsdata\3dModel\gpsOnly\gpsLoops.cls
Curvature, refraction correction: OFF
Maximum iterations: 10 , Convergence Limit: 0.002000
1983 State Plane Coordinates, zone:4803 Wisconsin South
Horizontal Units: Meters
Confidence Interval: 95.00
Project Geoid Height: 0.0000
Default Standard Errors:
Distance: Constant 0.010 , PPM: 5.000
Horiz. Angle: Pointing 10.0" , Reading: 3.0"
Vert. Angle: Pointing 3.0" , Reading: 3.0"
Total Station: Centering 0.005 , Height: 0.01
Target: Centering 0.01 , Height: 0.010
Azimuth: 5"
Coordinate Control: N:0.001, E:0.001, Z:0.030,
GPS: Centering:0.000, Vector Err. Factor:1.0

3-DIMENSIONAL ADJUSTMENT REPORT
==========================================

The following section shows the unadjusted measurements that make up the network. The control coordinates are displayed first followed by the GPS vectors. The control coordinates are displayed as latitude/longitude, SPC Grid XYZ, and geocentric XYZ. If geoid modeling is set both ellipsoid and orthometric elevations are displayed, ellipsoid elevation in the latitude/longitude section and orthometric elevation in the SPC section. The GPS vector section shows the unadjusted delta XYZ, variances and covariances of the vectors.

Unadjusted Observations
========================
Control Coordinates: 0 Observed Points, 2 Fixed Points, 0 Approx. Points
Sta. Latitude Longitude (Ellip.) StErr N: StErr E: StErr Z:
A 43-15'46.28901"N 89-59'42.16399"W 1382.62 FIXED FIXED FIXED
B 43-23'46.36261"N 89-54'00.75701"W 1235.46 FIXED FIXED FIXED

Grid XYZ
## Geocentric XYZ

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X: Y: Z: StErr</th>
<th>X: StErr</th>
<th>Y: StErr</th>
<th>Z: StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>402.3510</td>
<td>-4652995.3008</td>
<td>4349760.78</td>
<td>FIXED</td>
</tr>
<tr>
<td>B</td>
<td>8086.0316</td>
<td>-4642712.8473</td>
<td>4360439.08</td>
<td>FIXED</td>
</tr>
</tbody>
</table>

### GPS Vectors: 13 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>Delta X Variance</th>
<th>Delta X Covariance XY</th>
<th>Delta Y Variance</th>
<th>Delta Y Covariance XZ</th>
<th>Delta Z Variance</th>
<th>Delta Z Covariance YZ</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>11644.223</td>
<td>0.001969 -1.916E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>3601.217</td>
<td>0.001875 1.904E-005</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>-5321.716</td>
<td>0.0004316 -4.2E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>3634.075</td>
<td>0.003838 4.32E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>3960.544</td>
<td>0.000461 -4.46E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>-6681.247</td>
<td>0.005092 4.14E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>-11167.608</td>
<td>0.00054 -5.5E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-394.520</td>
<td>0.005442 5.7E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>15128.165</td>
<td>0.002922 -2.86E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>-6286.705</td>
<td>0.003228 2.68E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>-1837.746</td>
<td>0.002462 -2.38E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>-6253.853</td>
<td>0.002554 2.44E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>-1116.452</td>
<td>0.001495 -1.58E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>-4596.161</td>
<td>0.001319 1.76E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>10527.785</td>
<td>0.005134 -4.5E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>-994.938</td>
<td>0.004326 4.8E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>-6438.136</td>
<td>0.001889 -1.84E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>-962.069</td>
<td>0.001992 2.08E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>-4600.379</td>
<td>0.001866 -1.98E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>5291.779</td>
<td>0.001975 1.8E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>5414.431</td>
<td>0.002408 -1.98E-006</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Chapter 3. Survey Module*
The optional Traverse Closure section shows the GPS loop closures for the GPS loops defined in the closure, .CLS file.

Traverse Closures
=================

GPS Loop Points:
A,E,F,A

GPS Loop Closure;
Misclosure, X: -0.0323 Y: -0.0162 Z: -0.0105
Closure error: 0.0376 Perimeter: 20229.3858
Precision: 1:537594

GPS Loop Points:
C,F,D,B,C

GPS Loop Closure;
Misclosure, X: -0.0121 Y: -0.0101 Z: 0.0002
Closure error: 0.0158 Perimeter: 41332.9807
Precision: 1:2622216

GPS Loop Points:
F,D,B,F

GPS Loop Closure;
Misclosure, X: -0.0022 Y: -0.0044 Z: 0.0097
Closure error: 0.0109 Perimeter: 30814.5047
Precision: 1:2833226

Following are the final adjusted coordinates. Included in the report are point grid factor, elev. factor and the combined factor. Following the adjusted coordinates are the error ellipses, followed by the adjusted measurements section.

Adjusted Geographic Coordinates

Adjusted Grid Coordinates, (Meters)
Sta. N: E: Z (Geoid): StErr N: StErr E: StErr Z:
C 145233.5553 612043.7117 1103.10 0.0062 0.0062 0.0060
E 145091.9380 595081.6888 914.98 0.0053 0.0053 0.0052
D 154179.9383 596919.0552 894.01 0.0051 0.0050 0.0052
F 146611.7860 601518.4564 1024.24 0.0029 0.0027 0.0028
Chapter 3. Survey Module

Adjusted Geocentric Coordinates, (Metric)
Sta. X: Y: Z: StErr X: StErr Y: StErr Z:
C 12046.5807 -4649394.0824 4353160.060 0.0062 0.0062 0.0060
E -4919.3403 -4649361.2195 4352934.450 0.0053 0.0053 0.0052
D -3081.5836 -4643107.3693 4352934.450 0.0050 0.0051 0.0052
F 1518.8008 -4648399.1451 4354116.690 0.0027 0.0029 0.0028

Adjusted XYZ Coordinates Error Ellipses, 95% CI
Axis Axis
C 0.0161 0.0159 S 25-49'31.6''E 0.0157
E 0.0138 0.0137 S 29-24'51.2''E 0.0136
D 0.0133 0.0130 S 11-30'48.4''E 0.0135
F 0.0074 0.0070 S 05-18'52.7''E 0.0073

Adjusted Observations
================================
GPS Vectors: 13 Observations
From Sta. Delta X Residual StdRes StdDev
To Sta. Delta Y Residual StdRes StdDev
Delta Z Residual StdRes StdDev

A 11644.2435 0.0203 0.4581 0.0062
C 3601.2230 0.0065 0.1502 0.0062
3399.2795 0.0245 0.5521 0.0060
A -5321.7125 0.0039 0.1894 0.0053
E 3634.1005 0.0251 1.2810 0.0053
3173.6781 0.0129 0.6429 0.0052
B 3960.5330 -0.0112 0.5219 0.0062
C -6681.2418 0.0049 0.2181 0.0062
-7279.0098 0.0050 0.2378 0.0060
B -11167.6067 0.0009 0.0406 0.0050
D -394.5281 -0.0077 0.3288 0.0051
-907.9606 -0.0013 0.0568 0.0052
D 15128.1644 -0.0003 0.0194 0.0063
C -6286.7131 -0.0077 0.4275 0.0064
-6371.0592 -0.0009 0.0573 0.0061
D -1837.7566 -0.0107 0.6844 0.0056
E -6253.8502 0.0032 0.2060 0.0057
-6596.6687 0.0010 0.0619 0.0057
F -1116.4498 0.0025 0.2079 0.0027
A -4596.1557 0.0053 0.4606 0.0029
-4355.9139 -0.0077 0.6259 0.0028
F 10527.7799 -0.0053 0.2318 0.0061
C -994.9372 0.0005 0.0223 0.0061
-956.6272 -0.0026 0.1175 0.0060
The final section displays a variety statistical measures, followed by sideshots if there are any. Side shots would be a point that has only a single GPS vector going to or from the point.

Statistics
==========
Solution converged in 2 iterations
Degrees of freedom: 27
Reference variance: 0.26
Standard error unit Weight: +/-0.51
Failed the Chi-Square test at the 95.00 significance level
14.573 ≤ 6.927 ≤ 43.195

GPS Vectors and Total Station
Following is a report generated from a project that combined GPS vectors and total station data. Notice that the report is very similar to the GPS vector only project report. Explanations of the report are included in the report and are in bold, normal text.

-------------------------------
LEAST SQUARES ADJUSTMENT REPORT
-------------------------------

Mon May 08 15:08:39 2006
3D Geodetic Model.
Input Raw Files: C:\data\lsdata\3dModel\GPSCombined\rawCombined.cgr
GPS File: C:\data\lsdata\3dModel\GPSCombined\VectorJob.gps
Output File: C:\data\lsdata\3dModel\GPSCombined\gpsCombined2D.RPT
Curvature, refraction correction: OFF
Maximum iterations: 10 , Convergence Limit: 0.000200
1983 State Plane Coordinates, zone:0202 Arizona Central
Horizontal Units: Meters
Confidence Interval: 95.00
Project Geoid Height: -30.000
Default Standard Errors:
Distance: Constant 0.002 ,PPM: 5.000
Horiz. Angle: Pointing 0.6", Reading: 0.0" 
Vert. Angle: Pointing 2.0", Reading: 3.0"
Total Station: Centering 0.001 , Height: 0.002
Target: Centering 0.001 , Height: 0.002
Azimuth: 5"
Coordinate Control: N:0.010, E:0.010, Z:0.030,
GPS: Centering:0.001, Vector Err. Factor:10.0

3-DIMENSIONAL ADJUSTMENT REPORT
==================================

Notice that in this example geoid modeling was used. Notice that the ellipsoid elevation is displayed with the latitudes and longitudes. Orthometric elevations are displayed with the SPC83 grid coordinates.

Unadjusted Observations
========================
Control Coordinates: 0 Observed Points, 2 Fixed Points, 0 Approx. Points
Sta. Latitude Longitude Z (Ellip.) StErr N: StErr E: StErr Z:
17 32-58'09.73116''N 112-47'13.55718''W 179.384 FIXED FIXED FIXED
12 33-04'44.24403''N 112-54'36.04569''W 194.299 FIXED FIXED FIXED

Grid XYZ
Sta. N: E: Z (Geoid): StErr N: StErr E: StErr Z:
17 218691.215 131994.035 209.384 FIXED FIXED FIXED
12 230946.179 120618.775 224.299 FIXED FIXED FIXED

Geocentric XYZ
Sta. X: Y: Z: StErr X: StErr Y: StErr Z:
17 -2074605.540 -4938403.868 3451206.784 FIXED FIXED FIXED
12 -2082621.133 -4927852.115 3461405.389 FIXED FIXED FIXED

Notice that in the 3-D model distances are not reduced to horizontal or grid. Slope distances are reduced to mark to mark distances. A Mark to mark distance is the computed slope distance from the monument to monument.

Mark to Mark Slope Distances: 8 Observations
From Sta. To Sta. Dist. StErr
13 51 4013.947 0.022
51 52 2208.268 0.013
52 53 2202.068 0.013
53 18 2714.298 0.016
51 15 1601.219 0.010
52 15 2499.608 0.015
52 16 2639.678 0.015
53 16 2859.648 0.016

Notice that in the 3-D model distances vertical angles are considered as separate measurements. Vertical angles have also been converted to mark to mark vertical angles.

Mark to Mark Vertical Angles: 8 Observations
From Sta. To Sta. Vertical Ang. StErr (Sec.)
Horizontal Angles: 8 Observations
BS Sta. Occ. Sta. FS Sta. Angle StErr (Sec.)
12 13 51 067-58'23.5'' 0.8
13 51 52 160-18'01.7'' 0.9
51 52 53 213-47'22.1'' 0.9
52 53 18 198-52'17.3'' 0.9
13 51 15 240-35'47.0'' 0.9
51 52 15 320-50'46.2'' 0.9
52 53 16 142-02'01.5'' 0.9
52 53 16 061-14'43.7'' 0.9

GPS Vectors: 8 Observations
From Sta. Delta X Variance Delta X Covariance XY
To Sta. Delta Y Variance Delta Y Covariance XZ
Delta Z Variance Delta Z Covariance YZ

12 -507.728 6.64E-005 7.231E-005
13 -5749.936 0.0002136 -1.914E-005
-8484.249 7.969E-005 -6.468E-005
16 5291.644 4.281E-005 4.478E-005
15 -1175.977 0.0001066 6.211E-005
1127.564 0.0001289 -9.329E-005
13 4725.685 0.0001066 6.211E-005
15 -1175.977 0.0002265 -5.722E-005
1127.564 0.0001289 -9.329E-005
13 5799.369 5.779E-005 5.987E-005
16 1412.130 0.0001984 -1.63E-005
5435.492 7.569E-005 -6.123E-005
15 3797.625 0.0001611 0.0001685
17 -3625.824 9.022E-005 -2.464E-005
-2841.898 6.868E-005 -4.835E-005
16 2723.952 6.601E-005 6.098E-005
17 -6213.925 0.0001595 -3.951E-005
-7149.837 0.0001187 -8.61E-005
16 3983.996 4.166E-005 3.668E-005
18 -2884.461 9.022E-005 -2.464E-005
-1679.646 6.868E-005 -4.835E-005
17 1260.043 3.331E-005 2.912E-005

Chapter 3. Survey Module
### Adjusted Geographic Coordinates

**Adjusted Grid Coordinates, (Meters)**

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N</th>
<th>E</th>
<th>Z (Geoid)</th>
<th>StErr N</th>
<th>StErr E</th>
<th>StErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>220822.407</td>
<td>122293.821</td>
<td>205.469</td>
<td>0.011</td>
<td>0.006</td>
<td>0.007</td>
</tr>
<tr>
<td>51</td>
<td>222914.991</td>
<td>125719.002</td>
<td>200.982</td>
<td>0.013</td>
<td>0.008</td>
<td>0.028</td>
</tr>
<tr>
<td>52</td>
<td>224634.004</td>
<td>127105.001</td>
<td>191.980</td>
<td>0.011</td>
<td>0.009</td>
<td>0.028</td>
</tr>
<tr>
<td>53</td>
<td>225289.986</td>
<td>129206.984</td>
<td>202.983</td>
<td>0.011</td>
<td>0.008</td>
<td>0.032</td>
</tr>
<tr>
<td>18</td>
<td>225217.062</td>
<td>131920.203</td>
<td>204.850</td>
<td>0.008</td>
<td>0.005</td>
<td>0.007</td>
</tr>
<tr>
<td>15</td>
<td>222134.510</td>
<td>127117.007</td>
<td>188.195</td>
<td>0.013</td>
<td>0.008</td>
<td>0.011</td>
</tr>
<tr>
<td>16</td>
<td>227273.259</td>
<td>127147.034</td>
<td>186.643</td>
<td>0.007</td>
<td>0.004</td>
<td>0.006</td>
</tr>
</tbody>
</table>

**Adjusted Geocentric Coordinates, (Metric)**

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>StErr X</th>
<th>StErr Y</th>
<th>StErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>-2083128.851</td>
<td>-4933602.055</td>
<td>3452921.136</td>
<td>0.006</td>
<td>0.011</td>
<td>0.007</td>
</tr>
<tr>
<td>51</td>
<td>-2079539.552</td>
<td>-4933856.880</td>
<td>3454699.821</td>
<td>0.008</td>
<td>0.013</td>
<td>0.028</td>
</tr>
<tr>
<td>52</td>
<td>-2077907.135</td>
<td>-4933512.881</td>
<td>3456146.639</td>
<td>0.009</td>
<td>0.011</td>
<td>0.028</td>
</tr>
<tr>
<td>53</td>
<td>-2075836.064</td>
<td>-4933996.021</td>
<td>3456717.919</td>
<td>0.008</td>
<td>0.011</td>
<td>0.032</td>
</tr>
<tr>
<td>18</td>
<td>-2073345.496</td>
<td>-4935074.401</td>
<td>3456676.978</td>
<td>0.005</td>
<td>0.008</td>
<td>0.007</td>
</tr>
<tr>
<td>15</td>
<td>-2078403.158</td>
<td>-4934778.040</td>
<td>3454048.691</td>
<td>0.008</td>
<td>0.013</td>
<td>0.011</td>
</tr>
<tr>
<td>16</td>
<td>-2077329.484</td>
<td>-4932189.930</td>
<td>3458356.627</td>
<td>0.004</td>
<td>0.007</td>
<td>0.006</td>
</tr>
</tbody>
</table>

**Adjusted XYZ Coordinates Error Ellipses, 95% CI**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>0.030</td>
<td>0.013</td>
<td>N 20-10'14.1''E 0.019</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>0.036</td>
<td>0.019</td>
<td>N 21-18'08.4''E 0.071</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>0.029</td>
<td>0.020</td>
<td>N 29-51'55.4''E 0.072</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>0.030</td>
<td>0.021</td>
<td>N 19-08'38.0''E 0.083</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>0.022</td>
<td>0.010</td>
<td>N 26-26'36.4''E 0.018</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>0.034</td>
<td>0.020</td>
<td>N 17-51'28.5''E 0.028</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>0.021</td>
<td>0.009</td>
<td>N 22-55'33.0''E 0.014</td>
<td></td>
</tr>
</tbody>
</table>

### Adjusted Observations

#### Adjusted Mark to Mark Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>51</td>
<td>4013.941</td>
<td>-0.005</td>
<td>0.244</td>
<td>0.013</td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>2208.258</td>
<td>-0.011</td>
<td>0.803</td>
<td>0.010</td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>2202.072</td>
<td>0.004</td>
<td>0.281</td>
<td>0.011</td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td>2714.316</td>
<td>0.018</td>
<td>1.146</td>
<td>0.011</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>1601.218</td>
<td>-0.001</td>
<td>0.072</td>
<td>0.008</td>
</tr>
<tr>
<td>15</td>
<td>52</td>
<td>2499.610</td>
<td>0.002</td>
<td>0.145</td>
<td>0.008</td>
</tr>
<tr>
<td>16</td>
<td>52</td>
<td>2639.683</td>
<td>0.005</td>
<td>0.357</td>
<td>0.008</td>
</tr>
<tr>
<td>16</td>
<td>53</td>
<td>2859.656</td>
<td>0.008</td>
<td>0.469</td>
<td>0.008</td>
</tr>
<tr>
<td><strong>RMS</strong></td>
<td></td>
<td></td>
<td></td>
<td>0.008</td>
<td></td>
</tr>
</tbody>
</table>

#### Adjusted Angles

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>Occ. Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>StdRes.</th>
<th>StdDev (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>13</td>
<td>51</td>
<td>067-58'22.4''</td>
<td>-1.1 1.3 0.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>52</td>
<td>160-18'02.3''</td>
<td>0.6 0.7 0.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>53</td>
<td>213-47'22.2''</td>
<td>0.1 0.1 0.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Sta</td>
<td>To Sta</td>
<td>Vertical Ang</td>
<td>Residual</td>
<td>StdRes</td>
<td>StdDev (Sec.)</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>--------------</td>
<td>----------</td>
<td>--------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>51</td>
<td>090-04'55.5''</td>
<td>-9.0</td>
<td>2.5</td>
<td>1.4</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>090-14'36.5''</td>
<td>-3.5</td>
<td>1.0</td>
<td>2.9</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>089-43'25.0''</td>
<td>-1.2</td>
<td>0.3</td>
<td>3.1</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>18</td>
<td>089-58'22.0''</td>
<td>-0.7</td>
<td>0.2</td>
<td>2.4</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>52</td>
<td>090-27'53.0''</td>
<td>-1.0</td>
<td>0.3</td>
<td>3.4</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>53</td>
<td>05'52.9''</td>
<td>0.2</td>
<td>0.1</td>
<td>2.3</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>16</td>
<td>07'39.9''</td>
<td>-2.9</td>
<td>0.8</td>
<td>2.1</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>16</td>
<td>20'24.9''</td>
<td>-0.9</td>
<td>0.2</td>
<td>2.3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Root Mean Square (RMS)</td>
<td>3.6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**GPS Vectors: 8 Observations**

<table>
<thead>
<tr>
<th>From Sta</th>
<th>Delta X</th>
<th>Residual</th>
<th>StdRes</th>
<th>StdDev</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>-507.7297</td>
<td>-0.0022</td>
<td>0.267</td>
<td>0.0061</td>
</tr>
<tr>
<td>13</td>
<td>-5749.9259</td>
<td>0.0102</td>
<td>0.699</td>
<td>0.0109</td>
</tr>
<tr>
<td></td>
<td>-8484.2524</td>
<td>-0.0037</td>
<td>0.409</td>
<td>0.0072</td>
</tr>
<tr>
<td>12</td>
<td>5291.6464</td>
<td>0.0028</td>
<td>0.430</td>
<td>0.0045</td>
</tr>
<tr>
<td>16</td>
<td>-4337.7947</td>
<td>0.0096</td>
<td>0.785</td>
<td>0.0074</td>
</tr>
<tr>
<td></td>
<td>-3048.7649</td>
<td>-0.0095</td>
<td>1.298</td>
<td>0.0055</td>
</tr>
<tr>
<td>13</td>
<td>4725.6931</td>
<td>0.0085</td>
<td>0.818</td>
<td>0.0080</td>
</tr>
<tr>
<td>15</td>
<td>-1175.9849</td>
<td>-0.0083</td>
<td>0.549</td>
<td>0.0115</td>
</tr>
<tr>
<td></td>
<td>1127.5557</td>
<td>-0.0086</td>
<td>0.754</td>
<td>0.0100</td>
</tr>
<tr>
<td>13</td>
<td>5799.3676</td>
<td>-0.0014</td>
<td>0.185</td>
<td>0.0060</td>
</tr>
<tr>
<td>16</td>
<td>1412.1252</td>
<td>-0.0048</td>
<td>0.339</td>
<td>0.0107</td>
</tr>
<tr>
<td></td>
<td>5435.4912</td>
<td>-0.0010</td>
<td>0.116</td>
<td>0.0073</td>
</tr>
<tr>
<td>15</td>
<td>3797.6184</td>
<td>-0.0067</td>
<td>0.524</td>
<td>0.0083</td>
</tr>
<tr>
<td>17</td>
<td>-3625.8277</td>
<td>-0.0034</td>
<td>0.107</td>
<td>0.0128</td>
</tr>
<tr>
<td></td>
<td>-2841.9072</td>
<td>-0.0093</td>
<td>0.505</td>
<td>0.0109</td>
</tr>
<tr>
<td>16</td>
<td>2723.9438</td>
<td>-0.0081</td>
<td>0.999</td>
<td>0.0045</td>
</tr>
<tr>
<td>17</td>
<td>-6213.9378</td>
<td>-0.0129</td>
<td>1.022</td>
<td>0.0074</td>
</tr>
<tr>
<td></td>
<td>-7149.8428</td>
<td>-0.0061</td>
<td>0.562</td>
<td>0.0055</td>
</tr>
<tr>
<td>16</td>
<td>3983.9875</td>
<td>-0.0082</td>
<td>1.268</td>
<td>0.0054</td>
</tr>
<tr>
<td>18</td>
<td>-2884.4705</td>
<td>-0.0092</td>
<td>0.965</td>
<td>0.0079</td>
</tr>
<tr>
<td></td>
<td>-1679.6485</td>
<td>-0.0024</td>
<td>0.290</td>
<td>0.0069</td>
</tr>
<tr>
<td>17</td>
<td>1260.0437</td>
<td>0.0003</td>
<td>0.049</td>
<td>0.0052</td>
</tr>
<tr>
<td>18</td>
<td>3329.4673</td>
<td>0.0063</td>
<td>0.719</td>
<td>0.0079</td>
</tr>
<tr>
<td></td>
<td>5470.1943</td>
<td>0.0021</td>
<td>0.276</td>
<td>0.0069</td>
</tr>
</tbody>
</table>

Chapter 3. Survey Module
Statistics
==========
Solution converged in 3 iterations
Degrees of freedom: 27
Reference variance: 1.32
Standard error unit Weight: +/-1.15
Passed the Chi-Square test at the 95.00 significance level
14.573 <= 35.620 <= 43.195

Vertical Adjustment
=========================================
LEAST SQUARES VERTICAL ADJUSTMENT REPORT
=========================================
Tue Mar 21 17:37:27 2006
2D Geodetic Model.
Input Raw Files: C:\data\lsdata\cgstar\CGSTAR.CGR
Output File: C:\data\lsdata\cgstar\cgstar.RPT
Curvature, refraction correction: ON

FIXED VERTICAL BENCHMARKS
Station Elevation
 1  569.8500

POINTS TO BE ADJUSTED
Station
 2, 5, 3, 4, 10, 11, 12

MEASUREMENT SUMMARY
From To Elev. Diff. (unadjusted) StdErr
  1  5  7.5040  0.0145
  1  2  7.5659  0.0145
  2  3  6.9843  0.0145
  3  4 -11.4907  0.0146
  4  5  4.3557  0.0145
  5 10  2.2639  0.0143
 10 11  1.0931  0.0143
 11 12  0.3828  0.0143
 12  3  3.3590  0.0144

ADJUSTED ELEVATIONS
Station Adjusted Elev Standard Dev.
  1  569.8500  0.00000
  2  577.4336  0.02465
  5  577.3363  0.02465
  3  584.4355  0.02915
  4  572.9628  0.03070
 10  579.6003  0.03341
 11  580.6935  0.03641
 12  581.0764  0.03519

STATISTICAL SUMMARY
Total Unknown Elevations: 7
Total Elev. Routes: 9
Total Fixed BM's: 1
Total non-fixed BM's: 0
Degrees of freedom: 2

ADJUSTED MEASUREMENT SUMMARY
From To Elev. Diff. Residuals
(adjusted)
1 5 7.4863 -0.0177
1 2 7.5836 0.0177
2 3 7.0019 0.0177
3 4 -11.4728 0.0179
4 5 4.3735 0.0178
5 10 2.2641 0.0001
10 11 1.0932 0.0001
11 12 0.3829 0.0001
12 3 3.3591 0.0001

Vertical Sideshots
Station Elevation
20 571.77
21 581.25
22 580.14
15 579.60

**Draw Field to Finish**

This command turns data collector field notes into a final drawing by matching the descriptions of the field points with user-defined codes. The points are brought into the drawing with attributes defined by the code, including the layer, symbol, size and linetype. Draw Field to Finish also uses an improved coding method.
Example drawing results using the example points and example code definitions

Two files are used in Draw Field to Finish - a coordinate file and a field code definition file. The coordinate file consists of point#, x,y,z points with text description fields. The description fields contain codes for the Draw Field to Finish processing. An ASCII data file can be converted into a coordinate file using the Import Text/ASCII File command. The field code definition file defines the layer, symbol, size and other actions to apply with each code. These file names are displayed at the top line of the Draw Field to Finish dialog box.

Draw Field to Finish can translate the field points into Carlson points (also called coordinate geometry points or cogo points) with a symbol, layer, and size defined by the code. The point settings of whether to label the description, point number, and elevation and whether to locate the point at zero or at the real Z can be found in the Additional Draw Options of the Draw Field to Finish dialog box. The Draw-Locate Points command has these point settings stored separately in the Point Defaults menu. Draw-Locate Points provides a simpler method for drawing points compared with Draw Field to Finish.

Field-to-Finish will layerize the points and linework according to the code definitions. If the layers to use are not already defined, Field-to-Finish will create the necessary layers and assign different colors. To have the same colors for these layers in all your drawings, define the layers in the prototype drawing. The prototype drawing is the default drawing that is loaded whenever a new drawing is created. To define layers in the prototype drawing, save your current drawing and then start a new drawing with the New command. Don't give the new drawing a name, just click OK. Then define the layers as desired with the Layer command. When you are done creating layers, use the Save As command and change to Drawing Template (.DWT) under Save as Type. The default drawing template that is used is named Carlson12.DWT. This template name will correspond to the version of AutoCAD that is being used. You can overwrite this default template or make a new drawing template. If you make a new one, you may want to edit the Carlson icon to use the new one. To edit the icon, highlight the icon with one click and then click the right mouse button. Choose Properties and then Shortcut and change the drawing template name.

There are two different methods for connecting linework. One method creates line work by connecting points with the same code. The linetype is defined by the code as either points only (no line work), lines, 2D polylines, both 2D and 3D polylines, or 3D polylines (breaklines). Distinct lines with the same code are defined by adding a group number to the end of the code name in the data file. With this method, all points with the description CODE1 will be one line while points with CODE2 will be another line. Both CODE1 and CODE2 use the definition for CODE. For example, the code EP could be a code for edge of pavement that is to be connected as 3D polylines. If there are two separate edge of pavement lines on the left and right sides of a road, all the points for the left side could have the description EP1 and the points on the right side could be EP2.

The second method is the PointCAD format. This method also connects points with the same code. The difference is that instead of using a number after the code for distinct lines, you use the same code with an additional code for starting and ending the line. For example, +0 is used to start a line and -0 to end. So the coding for a segment of edge of pavement could be EP+0, EP, EP, EP-0. Another special code that has been added to Field to Finish is +7, -7. This 7 code will use the linetype definition of line, 2D polyline or 3D polyline defined by the Draw Field to Finish code. For example, if EP is defined as a 3D polyline, then the coding EP+7, EP, EP, EP-7 will create a 3D polyline. Otherwise codes like +0, -0, which is defined as start and end line, will draw EP as a line. Other PointCAD special codes are: +4 starts a curved 2D polyline, +4 starts a closed curved 2D polyline, +1 begins a 3-point arc, +5 starts a 3D polyline, *5 starts a closed 3D polyline, +6 starts a 2D polyline, *6 starts a closed 2D polyline, +7 starts a line whose type is specified by the field code definition, -50 starts a curved 3D polyline section, +8 starts a 2D and 3D polyline combination, +8 starts a closed 2D and 3D polyline combination, -08 starts a 2D and 3D polyline combination curved section, -80 ends that section, //, followed by a field code, concatenates that field code's description on to the point's description. For example, OAK//04 might become LIVE OAK TREE 4" if the field code OAK translates to LIVE OAK TREE and the field code 04 translates to 4".

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.
**Draw**

**Range of Points:** Specify the range of points to draw.

**Point Group:** Specify the point group(s) to process.

**Entities To Draw:** The Points option draws only the points and point attributes. The Lines option draws only the linework and the Symbols draws only the symbols. Any combination of these options can be processed as well as individual processing of each entity.
**Draw Within:** These options are methods to filter the points to draw. The Polyline method prompts for a closed polyline and only draws points inside this polyline. The Distance method uses a specified center point and distance to only draw points within this circle. The Window/Coordinate Range prompts for lower left and upper right points to define the rectangular area to draw points.

**Point Label Settings:** Specify whether you want Draw Field to Finish to label the Point Numbers, Descriptions, and/or Points Notes which are contained in the note (.NOT) file that is associated with the coordinate (.CRD) file.

**Elevation Label Settings:** Specify the elevation labeling options. The Label Zeros option will label the elevations of points with z=0. Use Parentheses will place parenthesis around the elevation text. Use '+' and Use '-' will place the appropriate symbol in front of the elevation.

**Locate Points on Real Z Axis:** Choose between locating all the points at real Z elevation, all at zero elevation or to use the real Z setting as defined in the individual codes.

**PC-PT Curve Type:** Sets the method for drawing curves with more than 3 points. The Bezier option draws a smooth polyline through all the curve points. The Sequential Arcs method draws multiple arcs with arc end points at each of the curve points. These arcs are tangent to the preceding line segment. The Best Fit method creates a single best-fit curve for all the curve points between the PC and PT.

**Layer Prefix:** Optional layer prefix added to all entities drawn with Draw Field to Finish.

**Erase Existing Draw Field to Finish Entities:** When checked, this option will erase from the drawing any old entities created by previous Field-To-Finish runs before drawing the new entities.

**In Range:** This option only erases and redraws those Draw Field to Finish entities that are within the specified range of points to process.

**Creating Point Groups:** Point Groups can be created in one or two different ways. Each field code definition can specify Point Group(s) that all point numbers that use that code will be added to. Multiple field codes can use the same Point Group name. Check the By Code Definition checkbox for that option. The second method is to automatically create Point Groups for each code that is processed. Check the Automatically By Code checkbox for that option. Ignore Code Suffix, if checked, will cause the codes to be considered after removing the numeric suffix. For example, points with the EP10 and EP11 codes will both be automatically added to the Point Group named EP. No matter how the Point Group is created, the Group Name Prefix can be used to add a prefix to the group name. Note: if the Point Group already exists, it will be erased first before being created again by either of these two methods.

Creating Point Notes: These options append point notes to the coordinate file data for some of the data fields processed by Field-to-Finish. These notes can then be used by other commands like List Points to report these fields. For example, this enables List Points to report both the point coordinate file description as well as the point drawing description as generated by Field-to-Finish.

Flip Text for Twist Screen: This option will rotate the point labels and symbol by 180 degrees when needed to make them right-side up readable relative to the current twist screen drawing view. This option applies to the Rotate To Line and Rotate special code (ROT).

**Pause on Undefined Codes:** When checked, Draw Field to Finish will pause if it encounters a description that is not defined in the code table.
Abort without drawing anything: This stops the command. Run Draw Field to Finish again to correct the code table.

Use the default settings for this point: This option draws a point in the "MISC" layer with no linework. To set your own default, define a code called "SC_DFLT".

Use default settings for all undefined codes: This option will draw all undefined codes in the "MISC" layer by default or a user specified layer as defined in the "SC_DFLT" code. A good way to check the data file for unmatched descriptions is to use the Print Table command and choose the Data Points and Distinct Code options. This command will print the different codes in the data file and identify any undefined codes.

Preview Only: When checked, this option will temporarily draw the points and linework and allow you to review it with zoom and pan.

Auto Zoom Extents: When checked, this will force a zoom extents after Draw Field to Finish is done.

Report Codes/Points: This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

Edit Codes / Points: The Field to Finish dialog box allows you to load the coordinate and field code definition files, view and edit the code definitions, view and edit the coordinate file, view reports, and then return to the Draw Field to Finish dialog box to process the files. The top section displays the code definitions. The bottom section has three columns of functions each pertaining to controls for different elements of the command. The Code Table section provides controls for settings, sorting and reporting of codes. The Code Definitions section provides tools for the creation and editing of codes. The Coordinate File section provides controls for coordinate files and points. It also contains the Draw controls which starts the processing of the data using Draw Field to Finish.

The code table editor has a list of categories and a spreadsheet of codes. The spreadsheet shows the codes for the currently highlighted category. The category toolbar buttons allow you to add, remove, edit the names and change the order of the categories. There are two fixed categories. The Unassigned category shows any codes with blank categories. The All category shows all the codes. You can control which fields are visible in the spreadsheet by
using the Column Options button. You can make edits to the fields in the spreadsheet or highlight a row and pick the Edit button to bring up a dialog to edit the code.

**Code Table**

**Code Table Settings:** These options provide tools for defining the coding method to be used for processing of the point data. Various import tools allow for the importing of codes from different software packages. Controls for handling multiple codes are located on this dialog. All special codes can be replaced to other characters defined by the user. The special codes are listed and edited on this dialog.

![Code Table Settings](image)

Set: Choose this button to specify a new code table. The name of the current table is shown in the field to the right of this button.

**Process Carlson Coding:** When checked, this option interprets and processes coordinate files based upon the Carlson Coding method and data collection method.

**Process Eagle Point Coding:** When checked, coordinate files are processed based on the Eagle Point Data Collection method. When selected the *Eagle Point Codes* button becomes available for selection and displays the following dialog. This dialog allows for customization of the eagle point special designators.

![Eagle Point Code Definition Settings](image)

Currently the supported designators include, "Field Code", "Point-On-Curve", "Close Line", "Line End", "Insert Description" and "Bearing Close". Also supported is the ability to recognize overwriting of descriptions just as Eagle Point does by using the space separator instead of the "Insert Description" designator. Examples of supported coding are as follows:

- **.TC** Places a node and or line per the field code library.
- **TC** Places a node and or line per the field code library.
- **-TC** Specifies a point on a curve.
- **TC-** Specifies a point on a curve.
- **.TC** Stops the line.
- **TC!** Stops the line.
- **.TC+** Closes the line back to the starting point.
TC+ Closes the line back to the starting point.
.TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
.TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
WV.WI Places a node as specified by the code "WV" in the field code library and then begins a line as specified by code "W" in the field code library.
.TC.EPFL Results in three lines coming together.
.TC1.TC2.TC3 Results in three lines coming together. All three lines are specified by the definition of the single code "TC" in the field code library.
TC.TC1 When used in conjunction with the "Draw Field Codes Without a Suffix as Points Only" toggle, "TC" will be recognized as the node and "TC1" will be recognized as the line so that if the code "TC" in the field code library is defined as a polyline, line or 3D polyline, duplicate lines will not be unintentionally placed when this shot only pertains to a single element. Keep in mind that all line work must have a numeric suffix when using this toggle.
_TREE * OAK Result on screen would be: TREE OAK
_TREE OAK * Result on screen would be: OAK TREE
_TREE OAK Result on screen would be: OAK
TC1!.TC2-.VLT6# Stops "TC1", continues "TC2" as a point on a curve and closes VLT6 as a rectangle using the "Bearing Close" code.

Note: The use of the "Use Multiple Codes for Linework Only" toggle is recommended when using Eagle Point Coding.

Process CAiCE Coding: When checked, coordinate files are processed based on the CAiCE Data Collection method. Examples of supported coding are as follows:
_169 is just the code 169.
_145C10 is the code 145 and line #10.
_169C25C is the code 169, line #25, and the point is on a curve.
_172C12B is the code 172, line #12, and this point closes the line.

Process SDMS Coding: This option processes coordinate files based upon SDMS coding method. When active, the program will prompt for an SDMS .PRJ file to process.

Split Multiple Codes:

Multiple codes are defined by including each code in the point description field separated by a space. A single data point can be used in different lines by assigning it multiple codes. For instance, a point might be part of both a curb line and a driveway line with a description of "CURB DRW". Field-to-Finish uses spaces as the delimiter for multiple codes. You should avoid spaces in the descriptions except for where multiple codes are intended or after the "/" character. For example, a code for light post should not be "LGT POST" but instead should be "LGTPPOST".

There are three options for the handling of multiple codes when encountered. The **All** option will split all multiple codes and process each code based upon their code definition. When **None** is select both codes will be processed based upon their code definition. If the **Prompt** option is checked on, when Field-to-Finish detects multiple codes on a point the following dialog will be displayed with options for handling the codes.
**Import Land Desktop Desc Key:** This option imports and converts a Land Desktop Description Key into a Carlson Draw Field to Finish (fld) code definition file. The Land Desktop Description Key file is an mdb file and is found in the Land Desktop Project file path. It is located in the under the COGO/DescKey directory.

**Import TDS Codes:** This option imports TDS codes into the Carlson Field to Finish (fld) code definition file.

**Import Trimble Codes:** This option imports Trimble .FXL file codes into the Carlson Field to Finish (fld) code definition file.

**Import Eagle Point Codes:** This option imports Eagle Point codes into the Carlson Field to Finish (fld) code definition file.

**Import C&G Description Table:** This option imports C&G code tables (tbl) into the Carlson Field to Finish (fld) code definition file.

**Import Text/ASCII Codes:** This option imports code definitions from a user-defined format. Each row in the text file should represent one code. The program will prompt for the delimiter (i.e., comma separated) that is used in the text file and then for the field type for each of the columns (i.e., "Layer" or "Description").

**Import GIS Feature Codes:** This option imports features in a .GIS file from Define GIS Features into F2F codes.

**Import SurvCE Codes:** This option imports a SurvCE Feature Code List (fcl) into a Carlson Field to Finish (fld) code definition file.

**Export SurvCE Codes:** This option creates a SurvCE Feature Code List (fcl) from the current Carlson Field to Finish (fld) code definition file.

**Draw Field Codes Without a Suffix as Points Only:** This option is useful for when wanting to use a field code sometimes for linework and sometimes for just points but it is preferred to number the lines rather than using start and stop codes. For example, if the field code EP is defined to use the Line Entity type, then EP25 will be drawn as a Line, however if just EP is used, no linework will connect to that COGO point.

**Use Multiple Codes for Linework Only:** When checked, and multiple codes are detected, only linework will be drawn for the secondary codes. Points are only created based on the primary code. If you want symbols for all multiple codes, then this setting should not be checked.

**Max Delta-Height for Linework:** Use this option to specify the maximum elevation difference that Draw Field to Finish should draw any section of linework. This option is for use with 3D polylines and lines.

**Max Length for Linework:** Specify the maximum length that Draw Field to Finish should draw any section of linework.

**GIS Special Codes:** This option allows you to use GIS attribute for Field-to-Finish special coding. For a select group of special codes, a GIS attribute can be assigned. When processing the points, if a point has GIS data for the specified attribute, then that attribute value is used for the special coding. For example, you can have a GIS attribute of COMMENT set to the Append Description special code. Then if a point has a GIS attribute for COMMENT, the value of that COMMENT will be added to the description label for that point.

**Substitution Codes:** This option defines a lookup table for translations of the raw point descriptions. This translation is done as a pre-processing step before the regular Field-to-Finish processing. For example, if you had a substitution setup for "25" = "EOP", then a point description of "25" would get translated to "EOP" and then this
"EOP" would be processed with Field-to-Finish. Use the Import and Export functions to load and save substitution codes to a comma separated text file.

**Special Codes:** This section allows you to substitute the existing predefined special codes and characters with your own. Draw Field to Finish recognizes several special codes. A special code is placed before or after the regular code with a space separating the code and special code. Here is a listing of the default special codes and characters.
Special Characters

The characters (*, -, +, /, and \) can be used and substituted in Draw Field to Finish. The way these characters are used is that when the file is processed the description field is searched for these characters. If the "+" symbol was changed to "-" then the program would look for "-" and change it to "+". This is useful when a particular data collector may not have all the symbols available. With these substitutions you can make a character that is provided on the data collector generate the symbol needed. Multiple characters can also be used. For example "-" can be used to in order to produce a "/'" character or any of the characters listed above.

Special Codes

"/'"

Carlson points in the drawing have point attributes including a description. When Field-to-Finish draws the points, the point description from the coordinate file is processed to match a code. The code then defines the description that is drawn with the point. For example, consider a code of "UP" with a description of "POLE" and a data point with the description "UP". The data point description "UP" would be matched with the code "UP" and the point would end up being drawn with the description "POLE". A special character "/'" (the forward slash or divide key) can be used for an unprocessed description to append. Everything after the "/'" is added directly to the point description and is not considered a code and no further substitution is done on it. For example, a data point with the description "UP / 150" with the same code "UP" definition above would be drawn with the description "POLE 150".

"\""

This special code takes the part of the description after the "\"" and puts it as the prefix before the point description. For example, a data point with the description "TR \ 24ft" and a "TR" code definition with a description of "Tree" would be drawn with a description of "24ft Tree".

"//"

This special code causes text after the "//" to be interpreted as a field code. That field code's description is then appended to the first field code's description. For example, if the field code 02 has the description 2" and the field code OAK has the description oak tree, then 02//OAK will result in the point having the description of 2" oak tree. If the "/'" character has been replaced with a different character, for example with a & character, then the "//" code would become "&&".

"\\"

This special code is the same as "//" except that field code's description is then prefixed instead of appended to the first field code's description.

MULT

This code applies when the Split Multiple Codes under Code Table Settings is set to None and you want to override this setting and explicitly split selected codes. Multiple codes apply to points with dual code definitions for drawing two different style points or for connecting different linework to the same point. For example, if a point is both a sidewalk and driveway corner, then the point description could be "SW MULTDR".

PC

This code begins a three point arc or a curved line when used with the "PT" code (see below). The point with this special code is the first point on the arc. The next point with the code is considered a point on the arc, and third point with the code is the arc endpoint. For example (in point number, X, Y, Z, description format),
10, 500, 500, 0, EP PC - start curve
11, 525, 527, 0, EP - second point on curve
12, 531, 533, 0, EP - end point of curve

**PT**

This is a special code that can be used with "PC" to define a curve with more than three points or a tangent two-point curve. Starting at the point with the "PC", the program will look for a "PT". If the "PT" is found, all the points between the "PC" and "PT" are used for the curve which is drawn as a smoothed polyline that passes through all points and only curves the polyline between points. If no "PT" is found, then the regular three point arc is applied as explained above. If no points are found between the "PC" and "PT", then the point prior to the "PC" and the point after the "PT" are used to create tangents for the resulting curve.

**CTOG**

This special code toggles curve mode on and off. Instead of using PC to start a curve, you can use CTOG. Likewise, instead of using PT to end a curve, you can use CTOG.

**CLO**

This code forces the lines drawn between a series of points with the same code to close back to the first point with the same code. For example, shots 1-4 all have the BLD description with the exception of point 4. Its description is BLD CLO. This will force the linework drawn for the BLD code to close back to point 1 which is the first point with the description of BLD.

**GAP**

This special code makes a single segment break in the current linework. For example, if you have a curb polyline that you want to break to skip over a driveway, then you could add the GAP code at the start of the driveway and continue the curb as normal on the other side.

**NE**

This code represents no elevation. A point with this special code is located at zero elevation.

**NOS**

This code indicates that the point should be "non-surface"; that is, that it should be ignored when contouring or creating surfaces. This can also be controlled per-field code by turning on the Non-Surface toggle in the Edit Field Code Definition dialog box.

**Offsets: OH, OV, OFL, OFB**

The codes "OH" and "OV" stand for offset horizontal and offset vertical. These offset codes apply to 2D and 3D polylines. A single set of offset codes can be used to offset the polyline a set amount. For example,

10, 500, 500, 100, EP OH2.5 OV-.5  
11, 525, 527, 101, EP  
12, 531, 533, 103, EP

This would create a polyline connecting points 10,11 and 12 and an offset polyline with a 2.5 horizontal and -0.5 vertical offset. The direction of the horizontal offset is determined by the direction of the polyline. A positive horizontal offset goes right from the polyline direction and a negative goes left. The horizontal and vertical offset amounts apply starting at the point with the offset codes until a new offset code or the end of the polyline. Only one
horizontal and vertical offset can be applied to 2D polylines. For 3D polylines, multiple offset codes can be used to make a variable offset. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP OH5.5 OV-.75
12, 531, 533, 103, EP OH7.5

This would offset the first point horizontal 2.5 and vertical -0.5, the second point horizontal 5.5 and vertical -0.75 and the third point horizontal 7.5 and vertical -0.75.

When there are multiple "OH" codes for the same point, the polyline is offset multiple times.

The "OFL" code stands for offset left horizontal. The only difference with the "OH" code is that you don't have to enter the "-" to go left.

The "OFB" code stands for offset both left and right horizontal. For example, if the points follow the center of a ROW, the OFB code can be used to create the left and right edges of the ROW.

SZ

This code is used to set a different symbol size. There are several ways to use this code. It can take multiple scale factors for different dimensions by putting an ID character after the factor.

SZ: If nothing follows the SZ code, then the next point with the same field code as the current point will be used to determine the size.
SZ#: The value of the new symbol size is specified after the SZ. This value is the actual size in drawing units. For example, SZ2.
SZ#X: The value after the SZ is used to scale the symbol in the X dimension. For example, SZ2X.
SZ#Y: The value after the SZ is used to scale the symbol in the Y dimension. For example, SZ2Y.
SZ#Z or SZ#V: The value after the SZ is used to scale the symbol in the Z (Vertical) dimension. For example, SZ2Z.
SZ#H: The value after the SZ is used to scale the symbol in the X,Y (Horizontal) dimensions. For example, SZ2H.
SZ#S: The value after the SZ is a symbol size scaler that get multiplied by the drawing horizontal scale to determine the actual drawing units. For example, SZ0.2S.

The X, Y, Z, V and H can be combined. For example, to scale a symbol by 10 horizontally and 25 vertically, use SZ10H25Z. Or to scale a symbol by 2 in the X direction and 4 in the Y direction, use SZ2X4Y.

When multiple SZ codes are used in the same point description, the symbol is drawn multiple times at the different sizes. For example, a point description of "TREE SZ5 SZ10" will draw the tree symbol twice. One symbol will be size 5 and the other size 10.

ROT

This code is used to set the rotation of the point symbol. If a point number follows the ROT code, then angle from the current point to this point number is used for the rotation. For example, "ROT45" would rotate the symbol towards point number 45. If there is no point number after the ROT code, then the rotation point is the next point number with the same code as the current point or a companion code for the current code. ROT can also be used to rotate towards an angle clockwise from north by using '+' or '-' in front of the number. For example ROT+45 rotates the point symbol to the northeast and ROT-90 rotates the point symbol to the west.

SMO
This code is used to smooth the polyline.

**AZI & DIST**

The AZI and DIST codes are used together to locate an offset point. The AZI sets the offset azimuth and DIST sets the distance. The values should directly follow the code. For example, AZI25 DIST4.2 would draw the point offset 4.2 at an azimuth of 25 degrees.

**JOG**

The "JOG" special code allows for additional points to be inserted into the line work at perpendicular or straight offsets. Only offsets should follow the JOG code. Positive numbers indicate a jog to the right and negative numbers indicate a jog to the left. Alternatively, "R#" and "L#" can be used where # is the distance to either the right or the left. Finally, "S#" can be used to make an offset straight ahead by using a positive # or behind by using a negative #. For example, "BLDG JOG S10.1 R5 L12.2 L5 L12.2" or equivalently "BLDG JOG S10.1 5-12.2 -5-12.2" advances 10.1 units and then draws a closed rectangle on the right hand side of an existing line. The offsets are always done in the X-Y plane. If the current line is vertical, an offset to the right is along the positive X-axis.

**JPN**

The "JPN" (Join to Point Name) special code joins to the point named immediately after the code. For example, "JPN205" causes a line to be drawn from the current point to the point "205". JPN is designed to work for adding a segment at the start of linework. So the point with the JPN code should be at first segment of the linework.

**NEAR**

This special code sets the current polyline to Nearest Found connection order. This applies to codes that have the Connection Order set to Sequential and you want to override this setting to Nearest Found for the current polyline.

**RECT**

The "RECT" special code causes a rectangle to be formed on a 2D or 3D polyline using one of two different methods. If a number follows "RECT" (e.g., "RECT10"), a rectangle will be drawn 10 units to the right of the last two points ending on the point with the "RECT" code. Use a negative offset to place the rectangle on the left side (e.g., "RECT-2.5"). For example if locating the left side of a 10’ rectangular concrete pad using the code conc for concrete, the description of the two left points would be (conc) for the first point and (conc rect10) for the second. If no number follows "RECT", then the polyline will be closed by shooting right angles from the first point of the polyline and the current point and creating a new point where those two lines cross. This method requires three points be established on the pad.

**LTF**

The "LTF" (LineType Flip) special code switches the side for the linetype. This option applies to non-symmetrical linetypes like the treeline or guard rail for when you want the linetype to face the other way.

**CIR**

The "CIR" special code stops the linework on the previous point and causes this point to create a circle in one of three different ways. The first way uses just the current point as the center with the CIR special code followed immediately by the radius. For example "CIR5.0" will create a circle centered on this point with radius 5 and at the elevation of the current point. The second method uses two points, the first point specifying the center and the elevation, and the second point specifying the radius. Only the first point has the "CIR" code. The third method uses 3 or more points that specify the perimeter of the circle in 2D with the first point specifying the elevation. For this
method, the "CIR" special code is only on the first point.

The "CIR" code can be used with all of the linetypes including "points only". The circles are always parallel to the X-Y plane.

**For Multi-Point 2ND Code**

When used on the first point of a multi-point symbol, the "2ND" code indicates that the second point of the sequence (i.e., the next point after the current one) should be used as the second symbol insertion point for a multi-point symbol. Please refer to Symbol Pts in the Edit Field Code Definition section below.

**For Multi-Point 3RD Code**

When used on the first point of a multi-point symbol, the "3RD" code indicates that the third point of the sequence should be used as the third symbol insertion point. The "3RD" code should be used with the "2ND" code. Please refer to Symbol Pts in the Edit Field Code Definition section below.

**3D Special Codes**

Below are the special codes that can be used for the easy creation of 3D surfaces. The resulting 3D face entities can be viewed in the Carlson 3D viewer by entering "cube" on the command line.

**FACE3D**

Makes a triangle mesh of 3D face entities by triangulating points starting with the current point and continuing until the line ends or another 3D special code is found. The points must be ordered along the perimeter. Although the mesh will be built if the points are clockwise or counterclockwise along the perimeter, the visible side in the Carlson 3D viewer, "cube", is the clockwise side by default. On the Advanced tab, the shading mode may be set to *Shade both* or *Shade back* if you would prefer to see both sides or just the counter-clockwise side.

**HOLE3D**
Makes an exclusion area within the triangle mesh identified by the point number following this code (e.g., "HOLE3D101" will start a hole in point # 101). If no point number is given ("HOLE3D"), the exclusion area is applied to the last mesh or if there is a mesh in the process of being constructed by the current sequence of points, it is ended and the hole is applied to it. Note that a hole can only be applied to a mesh that was created by FACE3D (not BLOCK3D or WALL3D). Note also that it can be difficult to predict what the "last mesh" was if it used a different field code since the points of the coordinate file are processed by order of field code first and then point number. There is no limit to how many holes can be applied to a FACE3D mesh. The points of the hole itself are not added to the FACE3D mesh; they are projected on to the best plane that contains the FACE3D mesh and then the hole is cut-out.

Example 1:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 VENT1 HOLE3D2500 /applies 2505-2508 as a hole to last mesh that uses point #2500. So any point in the range 2500-2504 would have the same effect.
2506 VENT1
2507 VENT1
2508 VENT1

Example 2:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 HOUSE1 HOLE3D /stops the above mesh and applies 2505-2508 as a hole
2506 HOUSE1
2507 HOUSE1
2508 HOUSE1

Example 3:
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D HOLE3D2503 /applies 2505-2508 as a hole to above mesh 2500-2504 and starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1

Example 4 (same result as Example 3):
2500 HOUSE1 FACE3D /front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D /starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1 HOLE3D2504/makes the mesh 2505-2508 also be a hole in the mesh 2500-2504.

BLOCK3D

Makes a set of 3D faces to make a 3d block using the height value entered after the code (e.g., "BLOCK3D2.3" with height 2.3). Heights can be positive or negative. With 3 points, makes a parallelogram base that is extruded up (or down if height is negative) to form a 6-sided block, including top and bottom. With 4 or more points, makes a closed polygon for the base that is then extruded by the height. The points can be laid out in clockwise or counterclockwise order around the perimeter. The perimeter or base does not have to be a convex polygon.

WALL3D

Makes a set of 3D faces above the polyline using a height value entered after the code (e.g., "WALL3D2.3" with height 2.3). The height can be negative if the points on the top of the wall have been shot. If no parameter exists, then the height is determined by the distance from the current point to the next point. This is a signed distance so the surveyor can shoot either the top of the wall or the bottom of the wall. Both sides of the wall will have triangles and so both sides will always be visible in the Carlson 3D viewer "cube".

Example 5 – 6’ high wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0/wall 6’
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example 6 – 6’ high wall, height specified by 1st to 2nd point, shot along the top:
2020 1100.000 1160.000 100.000 WALL2 WALL3D/height by 2nd pt
2021 1100.000 1160.000 106.000 WALL2
2022 1000.000 1160.000 106.000 WALL2

Load Default
This button sets the special codes to Carlson, Eagle Point, Geopak, InRoads or TMOSS defaults.

Code Table (continued)

Sort Table - This sorts the code table by either code name or layer.

Report Codes/Points - This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.
**Code Table by CRD** - This command will create code table definitions based on the coordinate file field descriptions. This is useful when creating a code table from scratch.

**Save:** Saves the Draw Field to Finish field code definition (.FLD) file.

**Save As:** Reacts the same as Save but allows for specification of file name and location to save to.

**Code Definitions**

**Edit:** If only one field code is selected, then this command opens the Edit Field Code Definition dialog box. If multiple field codes are selected (by holding down the control key or shift key and clicking on the rows), then the Multiple Set dialog box will open.
The code definition dialog has three tabs: General, Symbol and Linetype. Here are the settings under General:

**Processing ON:** This toggle controls whether this code will be processed.

**Code:** This is the key name that identifies the code and is matched with the field data descriptions. It is important to note that the * character, used in this field, is regarded as a wildcard or "match anything" code. For example, a field code definition with the code defined as TREE* will be used for any raw description of TREE. Raw descriptions of TREEA, TREE12, TREE, etc. will match the TREE code definition. This will always be the case unless there is a more specific code is found. For example is there was a code TREEA in the code definition file, then that code would be used instead of the TREE code.

**Use Code Sequence:** This specifies a sequence type code. Sequences are a way to simplify field entry of a sequence of codes. For example, a road cross-section could be SHD1 EP1 CL EP2 SHD2. Instead of entering these different descriptions, one sequence definition can store these descriptions in order. Then just the sequence code (such as RD) is used in the field. The cross-section can be shot in left to right then left right order, right to left then right to left order, or alternating left to right then right to left order. The alternating method is known as the Zorro style. The one restriction is that the shots always start from a right or left edge.

To set up a sequence, choose the Sequence toggle in the Edit Code dialog. Then pick the Define Code Sequence button. This brings up a dialog for entering the sequence codes in order. These sequence codes should be defined as normal codes somewhere else in the Draw Field to Finish code table (ie SHD as a 3D polyline). In the field, the one template code is used for all the cross-sections shots (ie RD for all the points). Then Draw Field to Finish will substitute this template code with the sequence codes (ie substitute RD with SHD).
Resulting points and linework showing Zorro style template

**Define Code Sequence:** This sets the code names that make up the sequence.

**Full Name:** This is an optional field that describes the code for viewing.

**Description:** This value is assigned to the point description attribute when the point is drawn. This description can be different than the field description. An additional description can be added to a point by entering it after a forward slash in the data description field.

**Use Raw Description:** This option turns off the Description field described above. Instead the points will be drawn with their original unprocessed descriptions. The Attribute Block option applies to the point block with
point #, elevation and description fields. The Text Attribute applies to drawing the description as text. The format of the description is controlled by the Attribute Format setting.

**Main Layer:** The point and line work for the code will be created in this layer.

**Distinct Point Layer:** When this toggle is selected, the line work is created in the layer defined in the Layer field and the points are created in the specified distinct point layer. For example, you could have DRIVEWAY for linework and DRIVEWAY_PNT for the points.

**Dual 3D Polyline Layer:** Displays the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer name can be typed in this field.

**Set 3D Layer:** Sets the layer that the 3d polyline will drawn on when using an Entity Type of 3D and 2D. The layer can be selected from the list or typed in at the bottom of the dialog box.

**Attribute Format:** This chooses the type of point entities to create. The Attribute Block format creates the Carlson point entity which is block with attributes for point#, elevation and description. The Text Attribute format creates text entities for each of the point attributes. When the Text Attribute format is selected, the Set button is available where you can control which attributes to draw as text and the position, rotation, decimals, style, prefix, suffix and layer for each attribute. The Offset Scalers control the distance for the text from the point for the different positions. These offset distances are calculated by multiplying the scaler by the horizontal scale for the drawing. The Avoid Overlap With Block Attributes option expands the offset distance starting point from the point to the bounding box that encloses the point block attributes.

![Point Attributes as Text Settings](image)

Also, for points notes and SurvCE GIS attributes, you can choose to all or selected fields. For selected, use the Add, Edit and Remove buttons to build the list of fields to label. To specify the field to label, the Sequence# method sets the field by its order position. For example, a sequence of 3 would use the third attribute for the point. The Name method sets the field to label by field name such as HRMS.

For each field, there are settings for the rotation, prefix, suffix, position, decimals, layer and style. The decimals setting applies to GIS fields that are real numbers.
Besides labeling attributes as text with this method, the Custom Attributes feature is a way to label attributes as block attributes.

**Separate Attribute Layers:** This controls the layers of the point and symbol attributes. With "None" the point layers are the standard layers, "PNTNO", "PNTELEV" and "PNTDESC", and the symbol layer is "PNT-MARK". With "Points" or "Both" the point attribute layers begin with the layer for the code followed by the attribute type. For example, the "DWL" code shown in this dialog has a layer name "DRIVEWAY". The point attributes would then be "DRIVEWAYNO", "DRIVEWAYELEV" and "DRIVEWAYDESC". With "Symbols" or "Both" the symbol attribute layer begins with the layer for the code followed by "MARK".

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in the drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Point Groups:** This field is for the name of the point group that all points with this code will be added to. If the points for this code belong to multiple point groups, you can specify multiple point group names in this field separated by commas. Under Draw in Additional Draw Options, there is an option whether to automatically use the code name as the point group name or to use the name defined in the code definition.

**Text Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size.

**Set Color:** The line work will be drawn in this color. The default is BYLAYER.

**Entity Type:** This defines the line entity to be created. Points only does not create any line work. 3D Polyline can be used for breaklines. 3D and 2D entity type selection creates a 3d polyline in the layer specified in the Dual 3d polyline layer setting and a 2d polyline in the layer identified in the Layer setting. Since 3d polylines do not display linetypes, this is useful when needing linework in 3d for design work while also needing to display linetypes for final plotting of the drawing. This provides an easy and quick way to turn off all 2d polylines or all 3d polylines by using the layer control dialog or the appropriate toggles in the Draw Points dialog.

**Elevation Integers:** This controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals:** This controls the display precision for the elevation label.
**Elevation Prefix/Suffix:** These set the prefix and suffix for the elevation label per code. In the Draw function under Additional Draw Settings, there is an override to set the elevation prefix/suffix for all the codes.

**Locate Pts on Real Z Axis:** This option will draw the points at the actual point elevation. Otherwise the points are drawn at zero elevation. For example, you could turn this option off for the FH for fire hydrant code to drawn them at zero. Then the GND code could have this option on to draw the ground shots at their elevations.

**Non-Surface:** Entities created with this flag are ignored when contouring or creating surfaces regardless of their elevation.

**Companion Codes:** This option allows different codes to connect when defined as line, polyline or 3d polyline. For example, a main line power pole code may be defined as PP while a service utility pole may be defined as UP. When processing Draw Field to Finish, it may be desired to connect all PP and UP codes together. This could be accomplished by defining a companion for UP as PP and a companion code for PP as UP. Each code needs to reference the other as a companion code.

![Companion Codes](image)

**Fixed Parameters:** This option is a coding method where you specify a sequence of parameters that follow the main code. There can be up to three parameters and these parameters can be an additional description or special codes Size, Rotate, Azimuth, Distance or Offsets. The purpose for Fixed Parameters is to save keystrokes by not having to enter the special code prefix. For example, for a code TR for Tree along with a size 12 feet and description of Oak, the special code description would be "TR SZ12 // OAK". With Fixed Parameters of Size and Description, the description would be "TR 12 OAK".

![Fixed Parameters](image)

**Data Collection Codes:** These settings apply to Carlson Field for turning on the Offset mode and Rotate mode automatically by F2F code.

![Data Collection Codes](image)
Here are the settings on the Symbol tab:

**Set Symbol:** This is the point symbol for the code. The dialog allows you to select from the symbols defined in the Symbol Library which is setup with the Settings->Symbol Library command. Besides the symbols from the symbol library, you can also use any symbols that are defined as blocks in the current drawing by entering the block name in the symbol edit box. To have a point without a symbol, use the Carlson symbol named SPT0 which represents "no symbol".

**Unit Symbol:** This option will draw the point symbol at unit (1:1) scale. For example, this option could be used for a symbol that is already drawn to actual dimensions such as a car symbol.

**Random Rotate:** This option will randomly rotate the symbol. For example, this option could be used for tree symbols to have the trees drawn in various orientations.

**Rotate To Line:** This option applies to points that are part of Field-to-Finish linework. This option will align the point attributes and symbol to the associated linework.

**Symbol Size Scaler:** This is a scaler value that is multiplied by the horizontal scale to obtain the actual size in the drawing. The horizontal scale can be set in Drawing Setup.

**Custom Attributes:** This feature allows you to use customized blocks that have customized attributes (the tag/value pairs). This feature works for both point attribute blocks and symbols. For attribute blocks, Field-to-Finish looks for attributes with the tags "PT#", "ELEV2", and "DESC2". The custom attributes feature allows you to define additional attributes in their custom blocks on a per-field code basis. The dialog shows five attributes at a time. The number of attributes is unlimited. Use the Next and Back buttons to show more attributes.

For an example, the custom block could have an attribute with the tag "TREE_SPECIES" and there is a separate field code for each species of tree. Each of those field codes can specify the value that should be assigned to the attribute that has the TREE_SPECIES tag. Then when the points are drawn, the tree species is shown. Note that the custom attributes must have their Constant and Preset properties set to "no". The custom attributes settings in F2F should not use those tags that the software already handles (PT#, ELEV2, and DESC2), or the setting will be ignored.
The Values for the attributes can be fixed strings that you enter in the dialog shown here. Or they can be dynamic parameters including point#, northing, easting, elevation or description for the current point as well as a point note or GIS attribute. To setup a parameter value, pick the Set button and then select the attribute. The Decimals setting applies to fields that are real values.

Besides labeling as block attributes, the Attribute Format method of Text mode is a way to label the attributes as text entities.

**Symbol Points:** For each code definition, the symbol insertion points can be defined with up to three points. To define the symbol insertion points, choose the Symbol Pts button in the Edit Code Definition dialog box. By default, the symbol insertion is defined by one point at the symbol center (0,0). A one point insertion definition can be used to insert a symbol offset from the center. With a two insertion point definitions, the program will rotate and scale the symbol. For example, two insertion points can be used to insert a tree symbol to size the tree, where the first point is for the tree center and the second is for the drip line. With three insertion point definitions, the program will rotate and scale the symbol in both X and Y. For example, three points can be used to insert a car symbol with the first point being the front drivers side, the second point as the back driver side (to rotate and scale the length) and the third as the back passenger side (to scale the width). Besides the insertion point coordinates, you can define a description for each point which is used for the drawn point description and is used for prompting in the Insert Multi-Point Symbol command and in Carlson Field data collection.
Three Point Symbol Drawing

The coordinates for the insertion point definitions are for the symbol at unit size. To figure these coordinates, you will need to open the symbol drawing (.DWG) file. By default, the symbols are located in the Carlson SUP directory. For example to make an insertion point for the tree drip line, open the tree symbol drawing and find the coordinate at the edge of the tree symbol (in this case 0.5,0.0).

![Diagram showing coordinates for tree symbol]

Two Point Symbol Drawing

Not all of the symbol insertion points need to be used when drawing the points. If a code definition has a three insertion points, it is possible to use just the first two or first one. There are special codes to associate multiple points to the same symbol. The first code point is used as the first symbol insertion point. The "2ND" code is used to specify the second symbol insertion point. A point number can follow the "2ND" to identify a specific point. Otherwise without the point number, the program will use the next point with the current code. The "3RD" code is
used to specify the third symbol insertion point and similar to the "2ND" code, a point number after the "3RD" is optional. The "2ND" and "3RD" codes should be assigned to the first point. For example, consider a code of "CAR" with a three point symbol insertion definition. If point #1 has a description of "CAR 2ND 3RD", then point #1 will be used as the first symbol insertion point and the next two points with the "CAR" description will be used as the second and third symbol insertion points.

Multi Point Symbol Drawing

**Draw 2nd Symbol:** This option creates a second symbol on each point. This additional symbol can be used to add a 3D symbol to a 2D symbol used as the first symbol. Besides selecting the symbol name, there are settings for the symbol size and layer.
Here are the settings on the Linetype tab:

**Set Linetype:** Line work can be drawn in any of the special linetypes or with the linetype for the layer ("BYLAYER"). There are three types of pre-defined linetypes: CAD, Entity and Continuous. The type is shown as part of the linetype names in the list. The CAD linetypes are the default linetypes available in AutoCAD and IntelliCAD. The Entity linetypes insert text or symbol entities at the linetype interval. These linetypes are the same as used with the Annotate->Polyline To Special Line command. The Continuous linetypes define a special linetype in CAD and create continuous polylines with that special linetype. These linetypes are the same as with the Annotate->Change Polyline Linetype command. Besides these pre-defined linetypes within Field-to-Finish, you can also use any linetype that is defined in the drawing by entering that linetype name in the linetype edit box or by picking the Select From Drawing button within the Set Linetype dialog. The spacing and size of the special linetypes is determined by the CAD LTSCALE system variable and by the field code settings *Line Type Spacing Scaler* and *Line Type Text Scaler*. The special linetype "hedge" is drawn with a user specified width. You will be prompted for this information when you select that linetype. The special linetype "userdash" is drawn with user specified distances for the length of the dash and the length of the gap between dashes.

**Line Width:** This controls the width for the linework. Only applies to 2D polylines.

Linetype Text: This is the text that is used for the user-defined linetype. First use Set Linetype to either Other_E or UserDef_C. Then this text will be used for the linetype. For example, if you have a code for a 8" PVC pipeline, then you could set this text to 8" PVC.

**Linetype Spacing Scaler:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the distance between symbols in the line.

**Linetype Text Scaler:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the size of the text in a line.

Flip Linetype: This option switches the side for the linetype which applies to non-symmetrical linetypes like the treeline or guard rail.

**Smooth Polyline:** This applies a modified Bezier smoothing to the polyline. The smoothed polyline will pass through all the original points.
**Hard Breakline:** This will tag the 3D polylines created with this code as hard breaklines. In *Triangulate & Contour*, contours are not smoothed as they cross hard barriers.

**Connection Order:** The points of a distinct code can be connected in their point number order or by nearest found which makes the line by adding the next closest point.

**Tie:** When checked the linework drawn with this code will always close. For example if you have points 1, 2, 3, and 4 with the code BLDG and Tie is checked on for the code BLDG, then the linework will be drawn from point 1 to 2 to 3 to 4 and then back to point 1, closing the figure.

**Linework Description:** This description is labeled along linework created by this code. The Set button displays a dialog to control the layer, style and size for these labels. You can also set the label interval.

![Linework Description Setup](image)

**Set Template:** For 3D polyline codes, this option allows you to assign a template (.TPL) file to the code. The code points act as the centerline for the template and the program will drawn parallel 3D polylines for each break point (grade ID) in the template. The template file is defined in the Civil Design module.

**Select All:** This option selects all the codes. This can be used when only wanting to process a couple of codes. For example, use the select all option to select all the codes and then turn them off. Now select the codes for processing and turn them on. Also it can be used to make a global change to all the codes.

**Add:** The new code definition is inserted in the list in the position after the currently selected one. If none are selected for positioning, the new code is placed at the top. Only one code definition may be highlighted before running this routine.

**Copy:** This option copies the definition of a selected code. It opens the Edit Field Code Definition dialog and copies the definition of the selected code to the appropriate settings. It does not copy the name of the code. It is a time saving tool to use when creating codes that are similar with only a couple of differences.

**Cut:** This command will remove the highlighted code definitions from the list and puts them in a buffer for retrieval with Paste.

**Paste:** This command will insert the code definitions put in the buffer by the Cut command. These codes will be inserted after the row of the currently highlighted code or at the top.

**Search:** Allows you to search for a specific code in the list.

**Coordinate File**

**Set CRD File:** This command allows you to specify a coordinate (.CRD,.CGC,.MDB,.ZAK) file to process.

**Edit Points:** This command opens the *Edit Points* spreadsheet editor. See *Edit Points* for more details.
Draw: This command returns to the Draw Field to Finish dialog box.

Coding Examples

Under the Carlson Projects folder, there is an example that shows the different ways for linework coding along with examples for many of the special codes. The examples are in f2f_example.crd and f2f_example.fld. Here is a breakdown of the features that the points illustrate.

Point 1: Point Entity by itself
Points 2-3: Using Begin code to start a line; end line using Begin code for next line
Points 4-5: Using Begin and End to start and stop linework
Point 6: Point Entity by itself after End code
Points 7-11: Linework by code defined as Polyline entity type; using End as break between linework
Points 12-15: Linework by code defined as Polyline entity type; using Begin as break between linework
Points 16-19: Linework by code defined as Polyline entity type; using # after code instead of Begin/End to separate linework
Points 20-22: Linework by code defined as Polyline entity type without using Begin/End to start/stop linework
Points 24-26: 3 point curve using on PC code
Points 27-30: 3+ point curve using PC/Point codes
Points 32-33: 2 point tangent curve using PC/Point codes
Points 35-39: reverse curve using PC/Point codes
Point 40: Regular point without extra description
Point 41: Using // to use a code description as a suffix
Point 42: Using \ to use a code description as a prefix
Point 43: Using / to append a description
Point 44: Using \ to add a description as a prefix
Point 45: Using ROT and a Point# to rotate to that Point#
Point 46: Using ROT and a value to set the rotation
Point 47: Using ROT by itself to rotate to the next Point#
Point 48: Regular point without rotation
Point 49: Using AZI and DIST codes to offset the point
Point 50: Using SZ with value to set size of symbol
Points 51-52: Using SZ by itself to size symbol by the distance to the next point
Point 53: Using SZ with 2 values to draw multiple symbols at those sizes
Points 54-55: Using 2ND code to size the symbol
Points 56-58: Using 2ND and 3RD codes to size the symbol in 2 dimensions
Points 59-62: Using CLO to close the linework
Points 63-64: Using RECT with two points and a value to create a rectangle
Points 65-67: Using RECT with three points to create a rectangle
Points 68-69: Using OH to offset right a fixed amount
Points 70-73: Using OH on multiple points to offset various amounts
Points 74-75: Using multiple OH on the same point to offset polyline multiple times
Points 76-77: Using OH with negative value for offset to left
Points 78-79: Using OFL with value for offset left a fixed amount
Points 80-81: Using OFB with value to offset both left and right a fixed amount
Point 82: Using CIR to draw circle at specified radius
Points 83-84: Using CIR to draw circle using two points for center and perimeter
Points 85-89: Using CIR to draw best-fit circle through points on perimeter
Points 90-91: Using JPN to join linework to another Point#
Points 92-95: Using SMO to create smoothed linework
Points 96-97: Using JOG to create additional linework segment extensions
Points 98-102: Using GAP to create a break in the linework
Points 103-106: Using LFT to switch linetype to left side
Points 107-109: Using WALL3D with specified height value
Points 110-112: Using WALL3D with height from 2nd point
Points 113-115: Using BLOCK3D with height and three points to define parallelogram
Points 116-123: Using BLOCK3D with height and multiple points to define perimeter
Points 124-128: Using FACE3D with multiple points to make a surface
Points 129-132: Using HOLE3D with multiple points to define the perimeter of a hole in the FACE3D surface
Point 133: Using code definition with Attribute Format set to Text and only Elevation turned on with Label Decimal

On Point

**PointCAD Coding**

Field-to-Finish supports an early Carlson style of linework coding called PointCAD. The PointCAD codes use numbers with +,-, symbols as follows:

+0 Starts a regular 2D line (not a polyline) that is open.
*0 Starts a regular 2D line that is closed.
*4 Starts a curved 2D polyline that is open.
+4 Starts a curved 2D polyline that is closed.
+1 Begins a 3-point arc.
-0 or -1 or -3 or -4 or -5 or -6 or -7 Ends a line.
+5 Starts a 3D polyline that is open.
*5 Starts a 3D polyline that is closed.
+6 Starts a 2D polyline that is open.
*6 Starts a 2D polyline that is closed.
+7 starts line whose type (2D line, 2D polyline, 3D polyline) is specified by the point's field code definition. If the field code definition is to use points, then a 2D line is started.
+2 Middle point of 3 point arc
-05 starts a curved 3D polyline section.
-50 ends a curved 3D polyline section.
+8 starts a 2D and 3D polyline combination that is open.
*8 starts a 2D and 3D polyline combination that is closed.
-8 ends a 2D and 3D polyline combination.
-08 starts a 2D and 3D polyline combination curve that is open.
-80 reverts back to a straight 2D and 3D polyline combination.
GIS Processing

With GIS processing activated, the entities created by Field-to-Finish are linked to a GIS feature name and attributes. These GIS links can be used by the routines in the GIS module such as Input-Edit GIS Data.

GIS processing in Field-to-Finish starts with the GIS Table setting in the initial Draw Field To Finish dialog. The GIS Table is the .GIS file created by the Define GIS Features command which defines the GIS feature names and attributes. Setting the GIS Table is optional but useful. The GIS Table is used as the reference in the Set functions for selecting a GIS feature name to assign to Field-to-Finish codes. Additionally, when processing the Field-to-Finish codes, any associated attributes from the GIS Table will be attached to the entities. Also, attributes generated from Field-to-Finish are added to the GIS Table. So using the GIS Table links the GIS module commands with Field-to-Finish.

Each Field-to-Finish code has settings to assign GIS feature names. In the Edit Field Code Definition dialog, the GIS Setup button brings up a dialog for setting the GIS feature names and attribute options for the current code. Since Field-to-Finish codes are capable of drawing both points and linework and GIS can have different features for points and linework, there are separate settings for the GIS feature names for points and linework. For example, a Field-to-Finish code UP for utility pole could be setup to draw both points with symbols at the poles and polylines between these points. Then you could have different GIS feature names for the pole points and linework with separate GIS attributes for each.

For Attributes to Create, these options create GIS attribute data which is stored in the database setup by the GIS Settings command and linked to the entities created by Field-to-Finish.
SurvCE GIS Fields: This option uses the attribute data generated by SurvCE which is stored in a .vtt file with the same file name as the current coordinate file except with the .vtt extension.
Field-to-Finish Code: This option creates an attribute named CODE with a value of the Field-to-Finish code name (ie. UP).
Field-to-Finish Full Name: This option creates an attribute named FULL_NAME with a value of the Field-to-Finish
Full Name (ie. Utility Pole).

Special Codes: This option creates attributes for Field-to-Finish special codes including OH (Offset Horizontal), OV (Offset Vertical), SZ (Size), ROT (Rotation), AZI (Azimuth) and DIST (Distance).

Point Number: This option creates an attribute named POINT_NAME with a value of the point number from the coordinate file.

Drawing Description: This option creates an attribute named POINT_DWG_DESC with a value of the point description for the point block created in the drawing.

Coordinate File Description: This option creates an attribute named POINT_RAW_DESC with a value of the point description from the coordinate file.

Default Code Tables
Default code tables are installed under Carlson Projects\Settings including Carlson.fld and the following DOT's: CA, CO, FL, IA, IL, IN, LA, MA, MD, MN, MO, MS, NC, ND, NE, NY, OH, SD, TX, WA and WI.

Tree Surveys
Tree surveys can be coded simply by using general Field-to-Finish coding methods such as defining a code for a tree ("OAK") with a tree symbol and using the SZ special code for sizing the symbol. For tree survey specific features, go to the Tree Survey button on the first Field-to-Finish dialog. This function brings up a dialog with tree survey settings. The tree survey works with three attributes for each tree: trunk, drip and tag. Trunk is the diameter of the tree trunk. Drip is the radius of the tree canopy. Tag is an id for the tree for reporting.

Important: The Tree Survey Settings apply to codes that are set to a Feature Type of Tree. To set the Feature Type, go to Edit Codes and then the General tab of the Edit Field Code Definition dialog.
On the Tree Entry Options dialog tab:

Begin Tree ID From: This is the number to start incrementing tree tags from in case the tree coding is missing tags and you want to assign tags for reporting.

Draw Point Attribute Block: controls whether to draw the point block with the point #, elevation and description attributes.

Draw Circle for Trunk Diameter: creates a circle with the trunk diameter.

Draw Treeline by Drip Radius in Scale: shrinks the tree driplines to get the overall treeline perimeter.

Draw Tree Symbol for Drip Radius in Scale: draws individual symbols for each tree using the symbols defined in the code table and scaled by the drip size attribute.

Draw Tree Symbol by Factor of Trunk Size: draws individual symbols for each tree using the symbols defined in the code table and scaled by the trunk size attribute multiplied by 12. For example, a 10” trunk size is drawn as a 10ft symbol.

Draw Same Size Tree Symbol: draws individual symbols for each tree using the symbols defined in the code table and at size of 6.
On the Layer dialog tab, there are optional layer names for different types of tree entities to append either as a prefix or suffix to the layer from the code table.

On the Description Codes tab, there are setting to help identify the tree attributes in the point description. The program looks for the trunk size, drip size and tag ID in the point description after the tree code. By default, the program expects the attributes to be in the order of trunk size, drip size and tag ID. Here’s an example default order:

OAK 16 12 100

where OAK is the tree code from the code table, 16 is the trunk diameter, 12 is the drip radius and 100 is the tag ID.

If the attributes are in a different order, then the suffix/prefix settings can be used to identify the attributes. When the program finds a specified prefix or suffix, that tells the program which attribute to use. For example, if the Trunk Suffix is "in" and the Drip Suffix is "ft" and the Tag Prefix is "T", then

OAK T100 16in 12ft

means tag ID of 100, trunk diameter 16 and drip radius 12 feet.
In addition to looking for the tree attributes in the point description, the program can also read these attributes from GIS fields. On the GIS Attributes dialog tab, you can set the GIS field names for the tree attributes.

On the Label tab, there are settings for the tree text labels for the size, offset from trunk center, style and location. When creating a tree table, only the tag text is labeled. Otherwise, the label is drawn. The Label Description Setup dialog sets which fields to include the the label, the field order, prefix and suffix.

When Field-to-Finish draws entities, the program checks for codes set as tree features and applies the settings from the Tree Survey dialog. When tree features are found, the number of trees are reported along with a prompt for whether to draw a tree table. The tree table has the tag ID, code description and trunk diameter.

Here is an example with the following three points:
Point# Northing Easting Description
1 4994.73 4923.15 OAK 24 38 301
2 5034.59 4881.40 PINE 18 24 302
3 4987.32 4975.79 PINE 12 20 303
Dripline drawn as Treeline method along with a tree table.

Another feature of Tree Survey is the Tree Report under the Report Codes/Points function. The Report Formatter option can be used to make a custom report and output to Excel or create a custom table in the drawing.

Tree ID Botanic Name Trunk
T301 Oak 24"
T302 Pine 18"
T303 Pine 12"

**Pull down Menu Location:** Survey

**Keyboard Command:** fld2fin

**Prerequisite:** A data file of points with descriptions
Field to Finish Inspector

This command reviews entities in the drawing created by Field To Finish. Point descriptions can be edited and the drawing is updated for both the point symbols and linework, using the Field To Finish coding.

Field to Finish Inspector docks a control panel dialog at the bottom of the screen which leaves the drawing view at the top.

**Code:** Lists the field codes that were found in the drawing. Clicking on a code causes the Instance list to show all of the linework and points that use the selected code.

**Instance:** Lists the linework and points of the currently selected code.

**Point:** Lists the points that make up the currently selected linework or point in the Instance list.

**Go to Point#:** Type in the point # to see in the drawing and then press this button to bring the point # into view. If the point # is not in the drawing, then a message will be printed at the top of the dialog box. If the Zoom toggle is on, then the point # will be brought to the center of the screen even if it was already visible on the screen. Likewise, if Isolate or Highlight are on, then those options will be applied, too.

**Zoom:** Check this checkbox to make the Field to Finish Inspector automatically zoom and pan the drawing so that the selected items in the above lists are viewable. Zoom is used on the Code and Instance lists. Pan is used for all three lists.

**Isolate:** Check this checkbox to make the Field to Finish Inspector only display the selected items in the above lists.

**Highlight:** Check this checkbox to make the Field to Finish Inspector highlight the selected items in the above lists.

**Restore View On Exit:** Check this checkbox to make the Field to Finish Inspector restore the zoom and pan values when you exit.

**Desc:** This edit box will display the description field from the coordinate file used on the given point(s). If the points do not all have the same description in the coordinate file, *varies* is displayed instead. If you type in a new description and then click on Apply, the new description will be applied to the coordinate file and Field-to-Finish will be used to process the coordinate file and update the drawing, including linework. Press the Code button to place an existing field code into this Desc edit box.

**Code:** Press this button to select a field code from the current field code definition (FLD) file. The following dialog box is an example of what you will see. The Categories on the left are the categories that are defined in the current field code definition file. The list on the right is all of the field codes in the selected category. Select (all categories) to see all of the codes in all of the categories. The selected field code will be placed in the Desc edit box.
Apply: Press this button to apply the modified description that is in the Desc edit box to the currently selected points. The below dialog box will come up that lists exactly what will be changed. Optionally, the raw file that was used to create the coordinate file will be updated as well. Press OK to continue. The description will be updated in the coordinate file and then Field-to-Finish will be used to process that coordinate file and finally the drawing will be updated to reflect the changes.

Code: This button generates a user-defined report with fields for the point number, coordinate, feature name and code. This report uses the Report Formatter to select which fields to include.
SAMPLE REPORT

Point# Code Full Name Feature Northing Easting Elevation Description
1 CM CONCRETE MONUMENT POINT 4922.730 5570.695 502.510 CM/(4'' DIAM)
2 CM CONCRETE MONUMENT POINT 4739.612 5499.121 506.050 CM
5 SHED SHED POLYLINE 4794.880 5495.289 505.110 SHED
6 SHED SHED POLYLINE 4771.855 5486.661 505.530 SHED
7 SHED SHED POLYLINE 4782.648 5457.861 505.820 SHED
11 18D 18'' TREE POINT 4889.990 5551.491 503.010 18D/OAK

Pulldown Menu Location: Survey
Keyboard Command: f2f.inspect
Prerequisite: Entities created by Field-to-Finish

Enter Deed Description

This command lets you enter line and curve data which is drawn and annotated as entered. When entering in data, the bearing quadrant and bearing value is input on the same line. For example, a bearing of N45-10-30E would be entered as 145.1030, where (1) represents the NE quadrant. The numeric codes for the quadrants are 1-4 beginning with NE as (1) and continuing sequentially in a clockwise direction to the NW quadrant (4). Distance data can be entered in Varas, Meters, Poles, Chains or US Feet. Curve data can be entered for Non-Tangent, Reverse-Tangent and Tangent curves. Data used to define curves includes but is not limited to Tangent Out Bearing, Radius data, Chord Bearing, DeltaAng and Tangent Length. Prompting for curve data is determined by what curve definition data is used. When you are finished, the closure and area of the figure is reported. The program has the option to Undo the previous data entry in case you need to re-enter values. Also, the program auto-saves the data entered during the command so that if the command is canceled and restarted, there's an option to resume entering data. The command starts with the dialog shown here.
**Line and Curve Layer:** Specify the layer name for lines and arcs.

**Points Layer:** Specify the layer name for the points.

**Traverse by:** Select between entering bearings, azimuth, gons or point numbers. The points option recalls points from the current coordinate (.CRD) file. The prompt option adds a prompt for each angle to specify the angle format.

**Point Format:** Choose between creating Carlson points in the coordinate (.CRD) file at each point in the figure, drawing descriptions only or having no point labels.

**Label Lines and Arcs:** Specify whether the annotation should be drawn on the lines and arcs or should be added to line and curve tables. The settings for the label styles are defined by the Annotate Defaults and Auto Annotate commands. Please see those commands in the manual for a description of those settings. You can either specify specific settings files from those commands or use the current settings which is the default.

**Deed Name:** Specify the beginning deed name. Only available when Store to Deed File is checked on.

**Draw Linework:** Specify whether or not to draw linework, if this is disabled then all annotation options are disabled also.

**Create Polyline:** This option creates a polyline of the deed perimeter instead of individual line and curve entities.

**Prompt for Descriptions:** Specify whether or not the program should prompt you for point descriptions. If this is not checked, then point descriptions are blank.

**Prompt for Elevations:** Specify whether or not the program should prompt you for point elevations. If this is not checked, then point elevations are set to zero.

**Plot Point Symbols:** If the Point Format is set to Descriptions Only or None, this option is available. It will place point symbols without creating points in the coordinate (.CRD) file.

**Create Radius Points:** When checked, radius points will be created for arcs. Radius points are given the description RADPT.

**Store to Raw Data (.RW5) File:** When checked, data entered will also be written to a raw data (.RW5) file that can be opened using the *Edit-Process Raw Data File* command. This file can be used to perform coordinate adjustments.
The Compass rule, Crandall rule, Transit rule, Angle balance adjustment and Least-square adjustment routines are all available. See Edit-Process Raw Data File for more information.

**Store to Deed File:** When checked, data entered will be written to a deed (.PDD) file. This file can be processed later to correct errors, create deed reports or to redraw the deed. To use this option, set the deed file name by picking the Specify File Name button. Also set the Deed Name field.

### Prompts

**Pick point or point number: 1**

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>North (y)</th>
<th>East (x)</th>
<th>Elev (z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8000.00</td>
<td>12000.00</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

In this example the coordinate for point number one has already been stored in the current coordinate (.CRD) file with the Draw-Locate Points command.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 145.3035

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 210.5 Enter P to input a distance in Pole format or C for Chains format.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: C Enter C to traverse through a curve.

**Tangent-out/Radius**: R

**Radius**: 1103.5

**Curve direction (Left/<Right>)? press Enter for right**

**Non-tangent/Reverse-tangent/Chord/Delta angle/Tangent/<Arc length>**: N If the curve is tangent to the previous leg then enter the arc length, enter C for a chord length, D to enter the delta angle or T to enter the tangent distance. In this example we have a non tangent curve so we entered N.

**Curve direction input [<Chord>/Radial]?**: C

**Chord Bearing (Qdd.mmss)**: 245.2341

**Length of Chord**: 201.22

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 345.3218

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 209.28

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 445.2348

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 200.54

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: E Enter E to end the prompting and calculate the closure error.

**Closure error distance**: 1.35251089 Error Bearing > N 70d41'35" E

**Closure Precision**: 1 in 607.63 Total Distance Traversed > 821.82

**Pulldown Menu Location**: Survey

**Keyboard Command**: PDD

**Prerequisite**: None

### Deed Reader

This command is used to extract deed line and curve data from the text of a deed. It shows the deed data in a spreadsheet and also graphically. The deed data can be saved to a deed file, drawn and reported. A blank Deed Reader dialog box appears as soon as the command is chosen.
The **Text** section is for entering in ASCII/TXT data for the deed. This can be accomplished by using the Paste button at the bottom of the dialog, or loading a filing using the Load button. You can also type information directly into this screen. **Reader Warnings** indicates irregularities in the deed text. The **Result** section is below that. This section will give you a detailed, editable spreadsheet of the deed, which can be saved. At the very bottom of the dialog is a section called **Summary**. Here is where you will see the mathematical and closure data for this deed displayed.

**Paste:** This is for pasting in copied information.

**Load:** This option will load an existing deed text (.TXT) file. Here is an example.
**Quick Settings:** This option allows you to set up, in a speedy fashion, the detailed criteria for this *Deed Reader* command.

**Settings:** A more formal settings feature, which is more methodical and dialog box driven.
Draw: This option will provide you choices as to how the date will be translated to the drawing screen.

It is in the Draw Options dialog that you can make decisions as to how detailed and involved your drawing will be. The Points section is key if you desire to have points created to a new coordinate file, or if you want to append an existing one. In the Annotations section, if Label Lines and Arcs is clicked on, the next dialog that you see, after choosing a point of origin, will be Auto- Annotate. Finally, click OK.

Prompts

Deed Reader dialog: enter in or load the deed text

Pulldown Menu Location: Survey
Keyboard Command: read_legal
Prerequisite: Deed text

Deed Linework ID
This command is used to report the deed name associated with selected linework. Since the Carlson deed commands that draw deeds attach the deed name to the linework, this command will extract that information and list it out. You can choose to select more than one deed linework entity before ending out of the command.

Prompts

Select deed linework to identify: select deed linework
Deed Name: Out Lot3 - Carlson Property
Select deed linework to identify (Enter to end): select Enter

Pulldown Menu Location: Survey
Keyboard Command: deed_id
Prerequisite: A deed name assigned to the entity

Deed Correlation
This command takes a set of field and design/deed points and creates an inverse report, such as radial stakeout, for each pair of points. The Align functions combine a translation and rotation to go from the survey points to the
deed points. The command includes a routine to find the best point to hold and the best point to rotate to. This command provides tools for the correlation of surveyed points with that of deed input points. Different points can be specified as hold points, or rotation points, and provide a report showing the bearing and distance of all sides of the traverse/deed, based upon the hold and rotation points. This allows for the review of different scenarios based upon hold and rotation points. Perhaps two points in the field are in good shape, and seem to meet all the descriptions thereof. You decide to hold these two points as good, but you would like to see what holding these points will do to each side/call of the tract/description. This is what this routine is designed to do. In addition to allowing user specified trials of different hold and rotation points, the routine also provides a Find Minimum Rotation option that will report which points specified as the hold and rotation points will result in the minimum rotation of all sides of the tract/description. All points must be contained in the same coordinate file, and the points to be used in the correlation must be specified as either Survey points or Deed points.

### Deed Correlation

<table>
<thead>
<tr>
<th>SURVEY POINT</th>
<th>DEED POINT</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.01</td>
</tr>
<tr>
<td>2</td>
<td>1.02</td>
</tr>
<tr>
<td>3</td>
<td>1.03</td>
</tr>
</tbody>
</table>

**Edit:** This button allows for editing of the highlighted/selected Survey and Deed point. Once selected the dialog above is displayed allowing for changes to be made.

**Add:** Click this button to specify the points as either Survey or Deed points. Then fill out the Edit Points dialog as desired.

**Remove:** This button will remove the highlighted/selected Survey and Deed points from the correlation setup. This does not delete the points from the coordinate file.

**Inverse Report:** This generates a report showing the inverse data from each point, both survey and deed, to every other point specified in the correlation set up. For example if there were four points in the survey points (1-4) then the report would show inverse data from 1 to 2, 3, 4; from 2 to 1, 3, 4; from 3 to 1, 2, 4 and from 4 to 1, 2, 3. This would be the same for the corresponding deed points.

**Compare Before Align:** This option compares the survey information to the deed information.

**Check Align:** This option that allows for user specified hold and rotation points, and then reports the inverse data of each side of the tract/description. The hold point and rotation point must be points from the specified survey point group.

**Find Min Align:** Determines the hold and rotation points that would result in the minimum rotation to each side of the tract/description. When selected the Minimum Deed Rotation Report is displayed.

**Apply Alignment:** This option can be issued after the Min Align criteria is set.

**Save:** Performs a quick save if the file has previously been saved.

**Save As:** This option prompts for a user specified file name and allows for a user specified location to save the file. The file extension for the deed correlation file is dcf. When executing the program you have the option of using an existing file or creating a new file for the deed correlation.

**Exit:** This button end the routine.

**Help:** This button displays the help topics relating to the Deed Correlation routine.
After specifying the hold and rotation points, the deed correlation report will display again, showing the bearing and distance of each side of the tract/description.
## Chapter 3. Survey Module

### Check Deed Rotation Report

**Hold Pivot Point**

Survey: 6  Deed: 1
Rotation Point

Survey: 7  Deed: 2
Translate X: -2.956  Y: -1.310
Rotation: 0°03'10"

<table>
<thead>
<tr>
<th>Survey Pt</th>
<th>Deed Pt</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>2</td>
<td>S 62°38'22&quot; W</td>
<td>3.009</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>S 78°33'32&quot; W</td>
<td>2.766</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>S 62°16'05&quot; W</td>
<td>2.134</td>
</tr>
<tr>
<td>10</td>
<td>5</td>
<td>S 71°43'06&quot; W</td>
<td>2.658</td>
</tr>
</tbody>
</table>

### Minimum Deed Rotation Report

**Hold Pivot Point**

Survey: 10  Deed: 5
Rotation Point

Survey: 7  Deed: 2
Translate X: 0.052  Y: -0.214
Rotation: 0°02'58"

<table>
<thead>
<tr>
<th>Survey Pt</th>
<th>Deed Pt</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>1</td>
<td>N 71°35'09&quot; E</td>
<td>2.693</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>S 10°40'01&quot; W</td>
<td>0.567</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>N 31°02'38&quot; W</td>
<td>0.298</td>
</tr>
<tr>
<td>9</td>
<td>4</td>
<td>S 73°20'09&quot; E</td>
<td>0.675</td>
</tr>
</tbody>
</table>
Pulldown Menu Location: Survey
Keyword Command: deed_align
Prerequisite: A coordinate file (.CRD)

**Process Deed File**

This command contains several functions for deed (.PDD) files. A deed file consists of one or more deed descriptions. Each deed description includes a deed name, starting coordinate and line/curve data. This deed data can be created with the *Enter Deed Description* command. This command begins with the Process Deed File dialog.

*Edit* opens the Edit Deed dialog where you can view or modify the deed name, starting coordinates, or line/curve data. Within this dialog the following commands are available.

*Add* opens the Edit Deed dialog where you can add a new deed.
Remove removes the currently highlighted deed.

Draw draws the currently highlighted deed in the drawing and returns to the main dialog. The actual geometry will not appear in the drawing until you exit Process Deed File. There is an option to label the deed using the settings from the Annotate Defaults and Auto-Annotate commands.

Report generates a report for the currently highlighted deed. The report is displayed in the Standard Report Viewer unless Use Report Formatter is active which allows for customized reports and Excel output using the Report Formatter. For the Report Closure, the Start-End Coordinates option uses the difference between the starting and ending coordinates to calculate the closure error. The Angle-Distance Precision option starts with the starting coordinate and calculates each point in the deed using the angle and distance values from the report until the final coordinate which is compared to the starting coordinate to calculate the closure error.

Copy creates a new deed by copying the geometry of the highlighted deed.

Export saves the selected deed data (.pdd) in raw file format (.rw5) that can be used with Edit-Process Raw File.
Save saves the currently loaded deed (.PDD) file.

Save As allows you to save the currently loaded deed (.PDD) file to another file name.

![Deed Report](image)

Remove removes the currently highlighted deed.

Draw draws the currently highlighted deed in the drawing and returns to the main dialog. The actual geometry will not appear in the drawing until you exit Process Deed File. There is an option to label the deed using the settings from the Annotate Defaults and Auto-Annotate commands.

Report generates a report for the currently highlighted deed. The report is displayed in the Standard Report Viewer unless Use Report Formatter is active which allows for customized reports and Excel output using the Report Formatter. For the Report Closure, the Start-End Coordinates option uses the difference between the starting and ending coordinates to calculate the closure error. The Angle-Distance Precision option starts with the starting coordinate and calculates each point in the deed using the angle and distance values from the report until the final coordinate which is compared to the starting coordinate to calculate the closure error.

Copy creates a new deed by copying the geometry of the highlighted deed.

Export saves the selected deed data (.pdd) in raw file format (.rw5) that can be used with Edit-Process Raw File.
Save saves the currently loaded deed (.PDD) file.

Save As allows you to save the currently loaded deed (.PDD) file to another file name.
List selects the starting coordinate from a point selection list from the current coordinate file.

Pick allows you to screen pick the starting coordinate.

Order allows you to set the sequence of the columns in the spreadsheet editor.

Add allows you to add a new deed call (line or curve).

Remove removes the highlighted deed call.

Move Up/Down change the list order of the data records for the currently highlighted row.

Angle Format chooses between using one spreadsheet cell for the angle in dd.mmss format or using three cells with dd, mm and ss in separate cells.

Pulldown Menu Location: Survey

Keyboard Command: deed

Prerequisite: None

Legal Description Writer

The Legal Description Writer gives you the ability to create a detailed legal description from a polyline. This description consists of calculated calls, point descriptions from Carlson points, and numerous user defined terms. The programs values for these terms are easily replaced, and are stored as defaults with each use. When a scale factor is specified under Drawing Setup, the Legal Description distances will apply the scale factor which is a way to report grid distances from ground drawing coordinates or vice versa.

In addition to this command that works by polylines, you can also generate legal descriptions by point numbers with the Report function within the Lot File Manager command.
Legal Description Writer Dialog
This initial and primary dialog box is shown above, and described below.

**Pick Boundary Polyline:** This button is used to designate the polyline boundary used. The boundary should be a closed polyline. Tools are provided in the Edit menu if you need to reverse the polyline or change its origin point. You can also select multiple polylines to process at the same time by entering M for Multiple at the Select Boundary Polyline prompt in this routine.

**Pick Inside Boundary:** This button is another way to designate the polyline boundary. With this method, the boundary can be defined by multiple linework entities. You pick inside the boundary area and the program will figure the boundary perimeter from the surrounding linework. This method uses the same technique as the Draw->Boundary Polyline command. The boundary perimeter that the program finds is highlighted for visual confirmation.

**Pick Reference Lines:** Used to select lines that tie into the polyline boundary used for the legal description. These should be LINE objects that have one endpoint exactly the same as the beginning point of the boundary polyline. If a Carlson point exists at the end of the line away from the boundary, the routine will pick up its description, otherwise you will be prompted for the description. You can choose any number of reference lines, simply press enter to conclude the selection of reference lines.

**Header File:** This button and edit field are used to designate the optional header text file. If a valid file is selected it will be written into the top of the output.

**Footer File:** This button and edit field are used to designate the optional footer text file. If a file is selected it will be written at the end of the output.

**Output Options** allows you to select where Legal Description Writer should send the output.

**Report Viewer:** The output is sent to the report viewer specified under Configure Carlson->General settings: Carlson Standard Report Viewer, Windows Notepad or Microsoft Word.

Chapter 3. Survey Module  546
**Text File:** The output is sent to an external text file as designated in the output file section described below.

**Mtext Object:** This creates a mtext object in the current drawing. Upon choosing OK you will be prompted for a starting point (which is the upper left corner) and well as a second point that determines the width and angle. By default ortho is turned on for this second point. Press the F8 key to toggle its status.

**Output File:** This button and edit field are used to designate the necessary output text file. This file can then be brought into your word processor and finalized. Note that the appearance of the output file can be affected by the status of the 'Use Paragraph Format' toggle in the Legal Description's General settings.

**Angle Specifications**

This section is used to establish the appearance of the bearings that are output with the description, and allows detailed control over each aspect.

**Bearing Format:** Designate the character or word used in each bearing direction. Standard values are the letters N,
S, E, or W. One possible option is the entire words NORTH, SOUTH, EAST, and WEST. It is important to keep in mind that spaces are literal, meaning that if you don't have a literal space after N/S, and before E/W, a space will not be formatted into the bearing. To use Azimuth, place a check in the Use Azimuth box and the General Prefix will be set to AZ.

**1-Words Quads:** For example bearings that are due NORTH, the default is to generate N 00° 00' 00 E. If the 1-Word Quads toggle is turned on, the program will substitute the single word (which you can change) for the direction, these usually being NORTH, or DUE NORTH.

**Symbols:** This section allows you to designate the precision for bearings, as well as the symbols used. Turn on/off the toggles for degrees, minutes, and seconds to control the precision. For example, if you wish to round to the nearest minute, simply clear the toggle from the second field. For each field (degrees, minutes, seconds), you can supply the character or word to be used. You can quickly fill in these fields with the two buttons to the right.

**Line Segment Specifications**
This section is used to establish the terms used when the course of a call is a line segment, as is often the case. Simply supply the beginning and ending terms for these line calls.

![Line Segment Specs](image)

**Curve Segment Specifications**
This large dialog is used to establish the terms and options used when creating the course of a curve. Basic options include beginning and ending terms, as well as the words for left and right if chosen. In the large table of curve options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. In the example below, the program would output the curve direction, arc length, radius length, chord bearing, and chord length, radius length, chord bearing, and chord length, and in that order. Each field can also have a unique prefix/suffix. There are four different possible phrases for the start of the curve description for whether the curve is tangential, non-tangential, compound or reverse. The Radial In/Out for Non-tangent Only option applies to the Radial In/Out fields and tell the program to only use these fields when the curve is non-tangent. Otherwise, these fields are always used when the Radial In/Out fields are in the sequence.
Spiral Specifications
This subdialog has the setting for reporting spiral portions of the boundary. In order to pick up the spiral, a centerline (.CL) containing the spiral must be drawn using the Draw Centerline File command. Then the program will pick up the spiral definition for any portion of the legal description boundary that follows the spiral on the centerline.

Distance Specifications
This subdialog is used to establish the terms and precision used when creating a distance for the course of a call. The precision and suffix apply to curves as well. Simply choose the desired distance precision from the popdown, and supply the beginning and ending terms for the line calls.

Note the availability of dual distance reporting. If you would like to report dual distances such as feet/metric, turn on the toggle in the lower left corner of the dialog. Note that the primary units are the units set in the Settings.
Description Specifications
In the process of following the polyline definition for a boundary, the legal description writer can look for
descriptions of the points at the endpoints of the polyline. These can be extracted by setting the data source to the
corresponding point from the coordinate (.CRD) file, meaning the points do not have to be plotted on the screen. A
second option is point block, in which the program will read the information from the drawing, and not require the
presence of a coordinate (.CRD) file.

Prefix: General term applied before the actual description.
Suffix: General term applied after the actual description.
Unknown: The text designated here will be placed in the description if the program does not find a valid description
at that coordinate location. The words ‘Unknown Point’ may be used.
Tolerance: The point must be within this distance of the polyline vertex to use the description.

General Specifications
This dialog controls general specifications which can affect the entire description. Each group of items are explained
in detail below.
Body of Description: Enter the beginning and ending terms for the description.

String Case: Choose the button corresponding to the string case conversion desired. If you want no changes made, choose none. Choosing upper, lower, or proper case conversion will affect the case of all text throughout the description, except bearing letters.

Report Sequence: This option controls the sequence to report the boundary segments either in the direction of the polyline, clockwise or counter-clockwise.

Spell Out Numbers: This option writes numbers as words instead of digits. For example, a distance of 123 would be written as one hundred twenty three.

Append Lines Output Format: If this toggle is on, the program will output the description without carriage returns after each line. This approach makes a nice paragraph style when brought into a word processor with word wrap. If the toggle is cleared, the program will place carriage returns at the end of each call.

Area
The legal description writer can output several types of areas. Basic options include beginning and ending terms. In the large table of area options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. You can edit the prefix/suffix for each and control decimal precision of each field output.
Reset: This option will reset all settings to their original default values.

Save: This option saves the legal description settings to a file. The file will be saved with an extension of (LGL).

Load: This option loads previously saved legal description (*.LGL) files.

Pulldown Menu Location: Survey
Keyboard Command: legal
Prerequisite: Polyline boundary

Closure by Point Numbers
This command allows for traverse entry by point numbers, reports the closure and supports traverse adjustments. Using an existing coordinate file, the traverse is defined by a series of point numbers. The angle and distance for each traverse segment is calculated using the coordinates of the points. The traverse can be processed using all adjustment routines. Refer to the Edit-Process Raw Data File command for more detail on adjustment procedures. After selecting Closure By Point Numbers from the Survey menu, the Closure By Point Numbers dialog will appear.
In this dialog shown above, add the point numbers that make up the traverse. This can be done by entering the point number, a range of points, or a point group into the Point Number(s) field. You can also choose points from a list by clicking the List button. Once each point, or group of points, is entered, click the Add button. Continue in this fashion until all of the point numbers are entered in. Clicking the Process button will display the Choose Process Method dialog. Choose the desired process method.
After selecting the process method for any of the adjustment methods, the dialogs and prompts will follow. They all start out with an "options" dialog box. These dialogs are titled either Process Options or Closure Options, depending on which process method you chose. The prompts that follow for any of the methods are subset of, and are very similar to, the prompting found in the *Edit-Process Raw Data File* command. After you have made your selections within these dialog boxes, click OK.

![Process Options Dialog](image1.png)

When you choose No Adjust of Angle Balance

![Closure Options Dialog](image2.png)

When you choose Transit, Compass or Crandall

Each of the process methods will display a report that details the closure before the adjustment, and after the adjustment. Options to save and print this report are available. After a review of the report, pressing Exit will remove the report from the screen. At this point a Process Results dialog, prompting whether to Update points in CRD file with adjusted coordinates, will appear. If you choose Yes, the active coordinate (.CRD) file will be updated with the adjusted coordinates. Choosing No will leave the active coordinate (.CRD) file in its existing state, with the coordinates unchanged. It is important to remember that the starting and ending point in this routine must be a different point number. For example, if the traverse starts at point 1 and ends at point 1, then another point number should be used for the tie in shot to point 1. This logic is different in *Edit-Process Raw Data File*, where the starting and ending point can be the same point number.
Map Check by Pnts

This command allows you to check the closure of a figure and produce a report. The points used for the map check should already be stored in a coordinate (.CRD) file, by using commands such as Traverse, Locate by Bearing, Curves menu, Locate by Angle – or perhaps a file from an electronic data collector.

Prompts

Table Description: Description
Beginning Point Number: 903
PointNo. Northing(Y) Easting(X) Elev(Z) Description
903 4940.73 2490.40 0.00
eXit/Curve/<point number>: 904

PointNo. Northing(Y) Easting(X) Elev(Z) Description
904 4850.89 2388.01 0.00
BEARING > S 48d43'58'' W Hz DIST > 136.21
eXit/Curve/<point number>: 905

PointNo. Northing(Y) Easting(X) Elev(Z) Description
905 4699.39 2423.32 0.00
BEARING > S 13d07'04'' E Hz DIST > 155.56
eXit/Curve/<point number>: 906

PointNo. Northing(Y) Easting(X) Elev(Z) Description
906 4653.59 2582.19 0.00
BEARING > S 73d55'04'' E Hz DIST > 165.34
eXit/Curve/<point number>: 910

PointNo. Northing(Y) Easting(X) Elev(Z) Description
910 4941.88 2492.50 0.00
BEARING > N 17d16'54'' W Hz DIST > 301.93
eXit/Curve/<point number>: X

Closure error distance > 2.39476609 Error Bearing > N 61°10'45'' E
Closure Precision > 1 in 316.96 Total Distance Traversed > 759.04
SQ. METERS: 30403.0 SQ. KILOMETERS: 0.03
HECTARES: 3.04 CUERDAS: 7.74 PERIMETER: 759.04

Pick area label centering point: pick point on screen for label text

Erase Polyline Yes/No <Yes>: N
### Pulldown Menu Location
Survey

### Keyboard Command
mc

### Prerequisite
Current coordinate (.CRD) file

### Mapcheck by Screen Entities

This command allows you to check the closure of a figure, and produce a report from the Distance and Bearing labels in the drawing. The command works by prompting for a polyline and a sample of the text labels. Then the program looks for text on the sample layer and matches the text labels to the polyline segments. The text to process can be selected manually or automatically using an offset factor from the polyline. The Deed Reader command is used here also, for extracting the deed line and curve data from the text of the deed. The deed data can then optionally be saved to deed file.
Cut Sheet

This command creates a report of the horizontal distance and elevation difference between points and a design. The design elevation can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported when a centerline is applied.

The data for the cut sheet is shown in a spreadsheet. You can edit or enter data in all the fields except for the Cut/Fill and Hz Error fields which are calculated. The cut sheet data can be saved and loaded with a .CUT file. The functions for processing the data are in the pull-down menus. Here's an outline of a typical workflow:

1. Import the survey data using Import > Points, or Import > SurvCE.
2. Assign the target design elevation using a method from the Grade menu.
3. If station-offset are needed, use a method from the Centerline menu.
5. Run File > SaveAs to save the cut sheet data.

File > New: Clears the spreadsheet.
File > Save: Saves the spreadsheet data to the current .CUT file.
File > SaveAs: Prompts for a .CUT file and saves the data.
File > Exit: Quits the program.

Edit > Delete Row: Deletes the currently highlighted spreadsheet row. You can also use the Delete key to delete the current row.
Edit > Insert Row: Inserts a new row above the current row. You can also use the down arrow key from the last row to add rows to the bottom of the spreadsheet, and use the Insert key to add a row above the current row.
Edit > Cut: Blanks out the data for the currently highlighted cells and puts this data into the Windows clipboard.
Edit > Copy: Copies the data for the currently highlighted cells into the Windows clipboard.
Edit > Paste: Puts data from the Windows clipboard into the spreadsheet starting at the currently highlighted cell.

Import > Points: Imports survey data from a coordinate file for the Point#, Northing, Easting, Survey Z and Description fields of the spreadsheet. This function first prompts for the coordinate file to import. Then there is a dialog to choose whether to select the points by point number range, by selecting point entities from the drawing, or by screen picking points. The Description Match and Ignore Zero Elevations are options for filtering out points.

Import > Note File: This method reads the survey data along with the grade elevation from the note (.NOT) file that is associated with a coordinate file. For example, if the coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software's data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using...
SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET_X, TARGET_Y, TARGET_Z, TARGET_DESC, TARGET_PT, STATION, OFFSET, VOFF1 and VOFF2.

Import > RW5 File: This method imports cut sheet data from a RW5 file of measurement data created by SurvCE. The stakeout functions in SurvCE store all the data needed to fill out the whole cut sheet including the survey data, design data and station-offset.

Import > SurvCE Cut Sheet: Imports data from a SurvCE Cut Sheet file (.CSV or .TXT). The setup for these cut sheet files in SurvCE is under File > Job Settings > Stake > Cut Sheets.

Grade > Points: The reference points to compare can be in the same coordinate file or a separate file. The reference/design points need to be matched with the survey points. The Match By Distance Tolerance method matches the design point that is closest to the survey point and within the specified Match Tolerance. The Point# Within Description method looks for the specified Point# Description Code in the descriptions of the design points and gets the survey point number from the suffix of the description code. When the Point# Description Code is found, the number after this code is used as the point# to match from the other file. For example, if description code is "PT" and the description for point# 101 in the first coordinate file is "CURB PT303", then point# 303 from the second coordinate file is used for the match. For the separate file option, there is a third method to match points between the files which is to use point numbers to match points between the files.

Grade > Triangulation File: the design elevation is determined by the elevation of the triangulation surface at each point.

Grade > Grid File: the design elevation is determined by the elevation of the grid surface at each point.

Grade > 3D Polyline: When using a 3D Polyline for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values.

Grade > Cross Sections: With Section Files, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

Grade > Runway Clearance: This option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes.
and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.

**Grade > Road Design:** This option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. **Grade to Process** is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in Cut Sheet is similar to the Process Road Design command.
Centerline > Centerline File: This function assigns the Station and Offset fields in the spreadsheet by prompting for a centerline file (.CL) and locating each point along the alignment.

Centerline > Polyline: This function assigns the Station and Offset fields in the spreadsheet by picking a polyline, entering the starting station, and locating each point along the alignment.

Centerline > Points: This method defines the alignment by entering two points to define a line.

Report > Create Report: This function display a report of the cut sheet data using the current report settings. When Use Report Formatter is off, the report is shown directly in the standard viewer. Otherwise, the Report Formatter dialog is shown for customizing the report and outputting to different formats such as Excel.

Report > Report Settings: There are several settings for the report including decimal precision, prefix for cut and fill and distance units. For the Horizontal and Vertical Tolerance, the report highlights any points that exceed these tolerances. The Distance Format chooses between Angle-Distance, Delta X/Y, and North-South-East-West deltas. The Cut/Fill Direction chooses whether to report cut/fill as Survey relative to Design or vice versa.
Draw > Draw Labels: This function uses the cut sheet data and draw settings to create labels in the drawing.

Draw > Label Settings: There are two types of labels to draw. The Mark Points Outside Tolerance draws a symbol at each point that exceeds the tolerances setup in Report Settings. The Draw Delta Symbol draws a symbol to show the direction of the delta X and delta Y along with the values. The Rotate Deltas By Centerline option prompts for a centerline to align the deltas. Otherwise, the deltas are due north-south and due east-west.

View > Zoom Plan View: This function zoom centers the drawing on the currently highlighted point.

View > Profile: Creates profiles connecting the survey and design points. The profiles are shown in a graphic preview dialog which has functions to save the profiles to .PRO files.

Examples of Cut Sheet reports comparing points are shown next.
Example 1: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.

Example 2: Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points.

Example 3: Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.
4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.

**Pulldown Menu Location:** Survey

**Keyboard Command:** cutrprt

**Prerequisite:** A coordinate (.CRD) file
Set Point Elevations by 3D Polylines

This command assigns elevations to points by referencing 3D polylines. The station-offset is calculated for each point to the nearest reference 3D polyline. The point must be within the specified Max Offset Tolerance in order to be elevated. The elevation is calculated from the elevation of the reference 3D polyline at the station combined with the specified percent slope times the offset plus the vertical offset. The Decimals setting is for the elevation label of the point. The elevation for the coordinate file always uses full precision. The option to Link Elevations To Polylines will update the point elevations when the reference polyline is changed.

Prompts

Options Dialog
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Select reference 3D polylines.
Select objects: pick the reference 3D polylines
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey and 3D Data in Civil
Keyboard Command: 3dpts, 3dp
Prerequisite: 3D polylines

Set Point Elevations by Surface Model

This command assigns elevations to points by a triangulation or grid surface model. For each of the points, the routine looks up the elevation from the surface model at the point x,y location. The option to Link Elevations To Surface Model will update the point elevations when the reference surface model is changed.

Prompts

Choose Grid or Tmesh file to process dialog choose existing GRD, TIN or FLT file
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Elevating points...
Elevated 10 points.

Pulldown Menu Location: Survey and 3D Data for Civil
Keyboard Command: 3dpts_tin
Prerequisite: A surface model

Polyline Report

This command generates a report of angle-distance and curve data for all the points along the selected polyline. The closure can be reported between the starting and ending points of the polyline. The polyline area can also be reported. After starting the command, by pressing O for options various report options can be selected.

Polyline Report
Northing   Easting  Bearing     Distance
4657.495   5452.844  N 40°45'51'' E 84.323
4721.362   5507.902  N 47°21'28'' E 122.817
Radius: 175.795 Chord: 249.282 Degree: 32°35'33'' Dir: Right
Length: 277.088 Delta: 90°18'35'' Tangent: 176.747
Chord BRG: N 85°55'08'' E Rad-In: S 49°14'09'' E Rad-Out: S 41°04'26'' W
Radius Point: 4606.577,5641.050
4739.102   5756.552  S 24°29'28'' E 122.817
4627.336   5807.466  S 74°29'33'' W 199.062
4574.114   5615.650  N 62°53'05'' W 182.885
4570.470   5452.866
Closure Error Distance> 0.03419 Error Bearing> N 41°22'21'' W
Closure Precision> 1 in 25333.8 Total Distance> 866.174
Polyline Area: 47735.6 sq ft, 1.1 acres

Prompts

Options/Select polyline to report: pick a polyline
Standard Report Viewer Displays the report for the selected polyline.
Options/Select polyline to report (Enter to End): press Enter
**Polyline to Deed File**

This command generates a deed (.PDD) file from the geometry of a selected polyline. This file can be opened using Process Deed File which allows you to edit the deed data and generate reports.

**Prompts**

Deed File To Write: *choose file location and name*
Select Polyline To Process: *select polyline*
Done.

**Polyline to RW5 File**

This command generates a raw data (.RW5) file for the selected polyline. This file can be opened using Edit Process Raw Data File, which allows you to process the raw data (.RW5) file to generate coordinate points, calculate closure and perform coordinate adjustments by the compass, crandall, transit and least squares adjustment routines.

**Prompts**

RW5 File to Write (Standard Windows File Selection Dialog): *choose file location and name*
Select Polyline To Process: *select polyline*
Done.

**Grant Boundary Adjustment**

This command applies a Grant Boundary Adjustment by rotating and scaling a polyline. Before running this command, the grid projection must be set in Drawing Setup and a polyline must be drawn.

The Grant Boundary method is used to set lost corners on perimeters within public lands. Distances between the record and measured are compared to define a ratio for adjustments. A rotation is defined by the difference between the record and measured bearings to preserve the angular relationship at the lost corners and to adjust the distance at the same ratio through each lost corner.
Prompts

Pick polyline for Grant Boundary Adjustment: *pick polyline*
Layer name for adjusted polyline <GRANT>: *press Enter*
Reverse polyline [Yes/No]? *press Enter*
Pick new closing point: *pick point*

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: grantadj
Prerequisite: A polyline

4 Sided Building

Often only one or two sides of a building are surveyed in the field. This routine completes the building by drawing the other sides. *4 Sided Building* creates a parallelogram given two connecting lines, or given a polyline with two segments. With two lines, there is an option to make the parallelogram as a polyline or as four lines. When only one side is defined, the program will prompt for the building width. Besides using linework to define the sides, you can use points by entering P at the prompt to switch to points mode.

Prompts

Options/Points/<Pick a line or polyline>: *pick a line*
Pick another side (Enter for none): *pick a line*
Convert the lines into a polyline [<Yes>/No]? *press Enter*
Options/Points/<Pick a line or polyline>: *press Enter*

Entering O for options lets you choose whether or not to be prompted to set the new polyline width, and for whether to default the width to make a square building with one sided input.

Pulldown Menu Location: Survey
Keyboard Command: 4sided
Prerequisite: A polyline with two segments or two adjoining lines

COGO Menu

This chapter provides information on using the commands from the COGO menu to perform coordinate geometry operations in your drawing. The top section provide basic COGO routines, with optional quick keys. The bottom section provides numerous survey functions, including the easy-to-use Visual COGO and also Numeric Pad COGO.
Inverse

This command reports the bearing/azimuth and horizontal distance between two points. The command prompts for a series of points. Use the appropriate object snap mode to select the points from the screen, or use the point numbers to reference coordinates stored in the current coordinate (.CRD) file. The results are then displayed. This command is also used in conjunction with the Traverse and Sideshot commands to occupy and backsight two points. The last two points you Inverse to are the Backsight and the Occupied point for the Traverse and Sideshot commands. An attractive feature of Inverse is that you can enter T or SS within the command and go directly to Traverse or Sideshot. Even a single S will transmit to Sideshot. Hotkeys are not case sensitive. Press [Enter] at the point prompt to end the command.

You can also inverse around an arc by inversing to the PC, and then entering an A for Arc option. The program will ask for the radius point, the curve direction left or right and the PT point. The curve data is then reported. There is an unequal PC-Radius and PT-Radius distance check. The tolerance for this is set in the Area Label Defaults command.

After picking the first point, there is a keyboard option for Multiple which will prompt for a range of point numbers to report as a sideshot inverse.

There are several input options for Inverse that are set by entering O for Options on the command line. Sideshot inverse holds the current occupied point and calculates the bearing/distance to each entered point. The Pairs option reports the bearing/distance between pairs of points and not for every entered point. For example, if points 1,2,11,12 were entered, the bearing/distance would be reported for 1,2 and 11,12 but not 2,11. The Auto Increment option uses the next point number by just pressing Enter. To exit the routine with Auto Increment active, End must be entered.

The Auto Zoom settings under Inverse Options will zoom the display as needed to have the occupied point or both the occupied and backsight points visible. The Report Total Distance option displays a running total of all inversed distances during the current run of the routine.

The Report Geodetic Mean Bearing option reports the geodetic bearing at the to point (forward), at the from point...
(back) and the mean bearing. The coordinates are converted to lat/lon using the projection setup under the Drawing Setup command. The program reports that lat/lon, convergence angle and grid scale factor at the from and to points.

Here's an example for SP83 VT,

Northing(Y) Easting(X) Elev(Z)
218623.2996 485210.2502 0.0000
Northing(Y) Easting(X) Elev(Z)
218439.0529 487144.1875 0.0000

Bearing: S 84°33'28'' E Horizontal Distance: 1942.6941325
Lat: 43°01'05.81806'' Long: -76°49'09.53807''
Convergence: N 02°56'59'' E Scale: 1.0014892493
Lat: 43°01'04.98404'' Long: -76°48'43.45145''
Convergence: N 02°56'41'' E Scale: 1.0014841465
Geodetic Forward Bearing: S 87°30'28'' E
Geodetic Back Bearing: S 87°30'09'' E
Geodetic Mean Bearing: S 87°30'18'' E

There are also several angle output options that are set at the second prompt in Options. The angle can be reported as either Bearing, Azimuth, Gon or Angle Right. You can also specify to report angles with decimal seconds. The distance settings include the number of decimals for distances, whether to report slope or horizontal distance and whether to report distances in feet and inches format. The Report Total Distance option will report the cumulative distance for all the inverses. The Report Delta X/Y will distances as delta north-south-east-west instead of angle and distance. For Report Latitude/Longitude, the grid projection must be set in Drawing Setup. The Report Coordinates option choose whether to report the northing, easting and elevation of the points. The Report Elevation Difference option will report the delta Z between the pairs of points. The Report Second Scaled Distance option will report a second distance value that is scaled from the first distance value using the scale factor defined in Drawing Setup. When the Second Scaled Distance option is on, there are settings for the suffix to use for both the first and second distance to help identify them separately in the report.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter.

Prompts

Calculate Bearing & Distance from starting point?
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: pick a point
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: 9
PtNo. Northing(Y) Easting(X) Elev(Z) Description
9 4909.25 4648.37 0.00
Bearing: N 81d8'54'' E Azimuth: 81d8'54''
Horizontal Distance: 261.17407461

Chapter 3. Survey Module 571
Pulldown Menu Location: COGO
Keyboard Commands: inverse, i
Prerequisite: None

**Occupy Point**

This command sets the occupied point and backsight angle for other COGO commands such as *Traverse*. For setting the occupied point, you have the option of picking a point on the screen, entering coordinates at the command line or typing in a point number that will be read from the current coordinate (.CRD) file. Four options are available for determining the backsight direction: Azimuth, Bearing, None and Point. For the default Point option, you may pick a point on the screen, input coordinates, or type a point number that will be read from the current coordinate file. For the Azimuth and Bearing option, you enter the backsight angle in the selected format. The None option sets the backsight to an azimuth of 0 (zero) or North. You can also set the occupied point by using the *Inverse* command. If you inverse from point 3 to point 1, you have set point 1 as the occupied point and point 3 as the backsight. For more information, see the *Inverse* command.

The current occupied point and backsight are shown in the lower right hand corner of the AutoCAD status bar just below the command line.

**Prompts**

- **Set Occupied Point**
  - Pick point or point number: *pick a point* (5000 5000 0.0)
  - Set backsight method [Azimuth/Bearing/None/Point]? press Enter

- **Set Backsight Point**
  - Pick point or point number: *pick a point* (5184.76 5381.3 0.0)

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all
Traverse
This command allows the user to input any combination of turned angles, azimuths or bearings to define a traverse or figure. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. This command always occupies the last point it calculated and backsights the point before that.

Codes 1 through 4 define the bearing quadrants:
1 = Northeast
2 = Southeast
3 = Southwest
4 = Northwest

The remaining codes define as follows:
5 = a north based azimuth
6 = an angle turned to the left
7 = an angle turned to the right
8 = a deflection angle left
9 = a deflection angle right

For both the Angle-Bearing Code and the Distance prompt, the user can enter point-defined responses: two points separated by an asterisk, as in 2*3 for the bearing (or distance) defined by 2 to 3. You can also add math expressions. For angles, 2*3+90 would deflect 90 degrees right from 2 to 3. For distance, 2*3/2 would mean half the distance of 2 to 3. You do not need to enter N before entering a number-defined distance. Just bring up the number inverse prompt.

The command draws lines between located points (if the Line On/Off in the COGO menu is set to on) and plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. The point settings are defined in the Point Defaults command. If Point Protect is turned on, Traverse checks if the point numbers are already stored in the file. Point Protect is set in the Coordinate File Utilities command.

There are Angle-Bearing code input options for Traverse that are set by entering O for Options. The Angle Right option prompts for the angle right and skips the angle-bearing code prompt. The Azimuth option prompts for the azimuth and skips the angle-bearing code prompt.

Prompts

Occupied Point ?
Pick point or point number: pick a point
You will only be prompted for the occupied point the first time you use the command.

Use the Inverse command to set the occupied and backsight points.

Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <>: o
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? p

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter Pressing Enter uses the default angle right code.

Enter Angle (ddd.mmss) <90.0000>: 88.1324 You can also enter L or R to define an angle 90 degrees Left or Right.

Backsight Point ?
Pick point or point number: pick a point
Number inverse/<Distance>: 100
Select Coordinate (.CRD) File

This dialog only appears if there is not a current coordinate (.CRD) file.

Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: 14*9-45.2045

Uses the bearing defined by point numbers 14 & 9 and subtracts the angle 45 degrees, 20 minutes, and 45 seconds. You can use a + or - in this type of entry.

Number inverse/<Distance>: N (note: you can enter 14*9/2 here, as well)

Point number inverse (i.e. 10*20): 14*9/2

This causes the command to recall the distance from point number 14 to 9 and divide it by 2.

Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: L

Select Line or Polyline that defines Bearing: select line that defines bearing

Number inverse/<Distance>: 100

Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>>: E

Enter E to end the command. Enter S or SS to execute the Side Shots command or I to execute the Inverse command.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO

Keyboard Commands: T, Traverse

Prerequisite: None

Side Shots

This command allows the user to input any combination of turned angles, azimuths or bearings while remaining on an occupied point. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. Codes 1 through 4 define the bearing quadrants; 1 being North-East, 2 South-East, 3 South-West, and 4 North-West. Code 5 is a north-based azimuth, 6 an angle turned to the left, 7 an angled turned to the right, 8 a deflection angle left and 9 a deflection angle right. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.

Prompts

Occupied Point?

Pick point or point number: screen pick a point or enter a point number

Exit/Options/Traverse/Inverse/Enter Azimuth (ddd.mmss) <A>: O for options

Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P for prompt

Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>>: 6

Code 6 for angle turned to left. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.
These prompts only come up if you have Instrument and Rod height prompting turned on.

Instrument Height <5.000> : 5.12
Rod-Target Height <5.12> : press Enter
Enter Point Description < >: Topo Shot
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <6> E

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: sideshot, ss
Prerequisite: None

**Enter-Assign Point**

This command creates a point at the user-entered coordinates. The point is both stored to the current coordinate (.CRD) file and drawn on the screen. The program will prompt for the northing and easting. This routine will prompt for point number, elevation and description, depending on the settings in the Point Defaults command. Point Defaults also allows you to set the point symbol and layer. Point Defaults is found under the Points pulldown.

**Prompts**

Enter North(y): 5000
Enter East(x): 5000
Select/<Enter Point Elevation <0.00>: Enter 100 for elevation, or press S and enter to select text to set elevation.
Enter Point Description < >: START
N: 5000.00 E: 5000.00 Z: 0.00
Enter North(y): press Enter to end

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: eapoint, ea
Prerequisite: None

**Raw File On/Off**

This menu selection toggles raw file (.RW5) creation. When this option is active, commands such as Traverse create entries in the current raw data (.RW5) file. If Raw File is turned on, the pulldown menu option will have a check mark character in the menu. A dialog will appear, allowing you to create a New, Append an existing, or Close the .RW5 file.

To begin this routine, select the COGO pulldown and observe the Raw File (On or Off) toggle for check. Click the command and the dialog appears.
**New:** Allows you to create a new raw traverse file (.RW5).

**Append:** Allows you to append an existing raw traverse file.

**Pulldown Menu Location:** COGO  
**Keyboard Command:** openraw  
**Prerequisite:** None

---

**Line On/Off**

This menu selection toggles line plotting on and off for the commands such as Traverse, Locate by Line Bearing, etc.. If line drawing is turned on, the pulldown menu option will have a check mark character to the left of the command.

**Command:** set_lonoff  
**Line ON**  
**Command:** set_lonoff  
**Line OFF**

---

**Visual COGO**

This command contains COGO routines for Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. Choosing Visual COGO from the COGO menu provides you with quick access to any one of five main features of the Visual COGO interface.

A dialog for command input docks on the side of the graphic window when any of the five options from the pulldown menu are selected. Points are drawn to the screen as they are created. Linework can also be drawn. CAD and Carlson commands can be activated with the Visual COGO dialog active. This allows for quick switching between Visual COGO commands and any other command. You can also switch between Visual COGO commands within the dialog by entering the 2 character function name in any edit box. For example, from Visual COGO Inverse, you can enter SS in the point number field to switch to Side Shots.
The function names OC, EA, IN, TR and SS are also available as function buttons across the top of the dialog. The second row of buttons are functions for zooming in/out and panning. The final button brings up Visual Cogo options. The Use Sound option is for whether to have sounds cues. The Prompt for Bearing/Azimuth Rotation adds an additional angle input in the Sideshot and Traverse functions. This angle is added to the bearing or azimuth angle input and is a way to handle North rotation where the orientation of the angles that your entering is different than the target coordinate system.

Prompts

When in Visual COGO, you will have a very different user interface from other areas of Carlson. This user-friendly screen will guide you through various COGO data entry procedures such as Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. You will still be able to follow the command on the command line at the bottom of your Carlson screen. Using Visual COGO is an alternative and easy method to entering in such information. The top half of the COGO pulldown menu offers you the more traditional Carlson data entry method. Your results will be the same.

IN (Inverse): This command reports the bearing/azimuth and horizontal distance between two points. The points can be entered manually or by picking from a point list by picking on the list button. The resulting report of bearing/azimuth is dependent upon the Angle Mode setting in the drawing setup options.

OC (Occupy Point): Used to specify the point number of the instrument setup point. The point can be specified by manually entering in the point number in the Occupied Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Backsight Method can be either by Point Number or by Azimuth. If angle right/left or deflection right/left is being used for traverse or sideshot entry, a backsight method must be specified. If using Bearing or Azimuth entry, no backsight method is required. The Backsight Point can be specified by manually entering in the point number in the Backsight Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Instrument Height: Use this field to set the height of the instrument.

Accept (F2): Selecting this button or pressing the F2 function key accepts the data entered in the fields above. After accepting the data, until changed, the points specified will remain the occupied and backsight points. If the dialog is exited without Accepting the settings the Occupied and Backsight points will have to be specified when the OC dialog is revisited.

Exit: Cancels the command

TR (Traverse): This command allows data entry using any combination of turned angles, deflections, azimuths or bearings to define a traverse or figure. This command always occupies, moves up to, the last point it calculated and backsights the point before, or the previous occupied point.

Point Number: This is the number of the point to be created.

Rod Height: Height of target to be located.
The horizontal angle component can be input in various formats. The format label will change with the option chosen. Choose the format by selecting the down arrow and picking from the list.

- NE=Northeast
- SE=Southeast
- SW=Southwest
- NW=Northwest
- AZ=Azimuth
- AL=Angle Left
- AR=Angle Right
- DL=Deflection Left
- DR=Deflection Right

The vertical angle component can be input in various ways (the format label will change with the option chosen). Choose the format by selecting the down arrow and picking from the list.

- VA=Vertical Angle. Zero (0) degrees is level.
- ZE=Zenith Angle. Ninety (90) degrees is level.
- DZ=Elevation Difference. The difference in elevation either plus or minus from the instrument setup to the target.

The distance component can be entered as either Slope or Horizontal Distance. Choose the format by selecting the down arrow and picking from the list.

- SD=Slope Distance
- HD=Horizontal Distance

Distance can be defined by Point Numbers by selecting the calculator button to the far right of Angle Right and Slope Distance.

Additional mathematical calculations of addition, subtraction, multiplication and division can be performed on the input distance by selecting the appropriate button and filling out the function dialog.
For example to add 25 to the Slope distance value on the traverse dialog, select the + button, enter 25 and then select Done. The same steps apply to any of the other mathematical functions.

**Side Shots:** This command works in the same way as the traverse command. All the available options contained in the traverse command are available in this command. The only difference in the commands is that the side shot command does not move the setup point to last shot input. Refer to the traverse command for further details.

**Desc:** Defines the description for the point to be created.

**Create Point:** Option whether to store the point to the CRD file and draw a point.

**Draw Line:** Option to draw line to the traverse point.

**Preview (F2):** Previews the traverse point location, without storing the point to the coordinate file.

**Store (F3):** Stores the traverse point based upon the entered data to the coordinate file.

**Undo:** After storing the point, the point can be deleted from the screen and coordinate file by selecting the undo button.

**Exit:** Exits the Visual COGO command and closes the dialog box.

**EA (Enter Assign):** Use this function to enter and assign coordinate values for new and existing points.
Zooming and panning functions are also available from the Visual COGO dialog box:

**Plus (+) magnifier:** Zooms the display window in. Use to view an area up close.

**Minus (-) magnifier:** Zooms the display window out. This shows more of the drawing.

**Left arrow:** Pans the display window to the left.

**Right arrow:** Pans the display window to the right.

**Up arrow:** Pans the display window up.

**Down arrow:** Pans the display window down.

**Pulldown Menu Location:** COGO

**Keyboard Commands:** vcogo_inverse, vcogo_setup, vcogo_traverse, vcogo_sideshot, vcogo_store

**Prerequisite:** Coordinate file to process

---

**Locate by Line Bearing**

This command calculates and plots a line (if the Line On/Off is set to Line On) and point from an occupied point. The bearing can be defined by picking two points, selecting a line, inputting two point numbers, or typing in a bearing or azimuth. The command always occupies the last point calculated.

**Prompts**

Press [Enter] to use preview point/or select occupied point.

Pick point or point number: 14


<table>
<thead>
<tr>
<th>PointNo.</th>
<th>North(Y)</th>
<th>East(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>4869.06</td>
<td>4390.31</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Pick points that define bearing.

Define Bearing by, Line/Bearing/Numbers/<pick 1st point>: B

At this prompt the default is to pick the first point that defines the bearing. If you pick a point, you are then prompted for a second point. You can input B to type in a bearing or azimuth or L to select a line or polyline that defines the bearing, or N to input two point numbers that define the bearing.

[A]zimuth/<Bear ing (Qdd.mmss)>: A
Azimuth (ddd.mmss): 45.2349  
Number inverse/<Distance>: 188.27  
Enter Vertical Angle (dd.mmss) <0.0000>: press Enter  
The horizontal distance is given.  
Enter Point Description <stk>: press Enter  
The coordinates are given.  
Pulldown Menu Location: COGO > Locate by Bearing-Ang  
Keyboard Command: locbrg, lb  
Prerequisite: None  

Locate by Turned Angle  
This command locates a point by turned angle and distance.  

Prompts  
Define occupied & backsight points by [L]ine or [P]oints <P>: L  
Select Line or Polyline near end point that defines occupied point: select line  
Occupied point: (4078.44 4610.89 0.0)  
Backsight point: (4390.31 4869.06 0.0)  
Enter Angle (ddd.mmss) <45.2349>: 22.5632  
Pick or Type Distance <188.27>: 40.32  
Enter Vertical Angle (dd.mmss) <0.0000>: hit Enter  
Pulldown Menu Location: COGO > Locate by Bearing-Ang  
Keyboard Commands: turnang2, ta  
Prerequisite: None  

Locate by Azimuth  
This command locates points by azimuth and distance. The AutoCAD text screen provides the horizontal distance and coordinates.  

Prompts  
[Enter] to use preview point/ or Select occupied point ?  
Pick point/<point Number>: _endp of (pick a point)  
Enter Azimuth (ddd.mmss) <22.5632>: 277.1259  
Enter or pick Distance <40.32>: 104.39  
Enter Vertical Angle (dd.mmss) <0.0000>: Enter  
Pulldown Menu Location: COGO > Locate by Bearing-Ang  
Keyboard Commands: locazi2, az  
Prerequisite: None  

Locate by Bearing  
This command locates points by bearing and distance. Additionally, the AutoCAD text screen provides the horizontal distance and coordinates.  

Prompts
[Enter] to use preview point or Select occupied point?
Pick point/ <point Number>: 24

PointNo. Northing(Y) Easting(X) Elev(Z) Description
24 4922.37 4544.81 0.00

Enter Bearing (Qdd.mmss) <277.1259>: 435.2317
Enter or pick Distance <104.39>: 200
Enter Vertical Angle (dd.mmss) <0.0000>: Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg2, lg
Prerequisite: None

Locate by Delta
This command locates points by specified delta x, y, z from a reference point. The point style and whether to prompt for a description is set in Point Defaults.

Prompts

[Enter] to use preview point/ or Select occupied point?
Pick point/ <point Number>: pick a point
Delta Northing (dy): 23.45
Delta Easting (dx): 12.34
Delta Elevation (dz) <0.0>: press Enter
Enter Point Description <>: press Enter
N: 11687.04 E: 10095.31 Z: 0.00
Delta Northing (Enter to end): press Enter

Pulldown Menu Location: COGO > Locate by Angle-Distance
Keyboard Commands: locdelta
Prerequisite: None

Pick Intersection Points
This command locates points at screen picked intersections. The object snap mode is set to intersection. This routine is similar to the Locate Point command, with an additional check that makes sure there is an intersection at the picked point. If there is not an intersection at the picked point, then no point is created.
Prompts

Pick Intersections Points dialog

APParent intersection on [<Yes>/No]: Y

This first prompt is very important. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multilinie, polyline, ray, spline, or xline) that do not intersect in 3D space, but may appear to intersect in the current view. This allows you to locate a point at the theoretical intersection of two 3D entities. You should answer No to this prompt if you want to ignore theoretical 3D intersections.

[app on] Pick intersection Point: pick a point
[app on] Pick intersection Point: press Enter to end

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: pickint
Prerequisite: Intersection of two entities

Linework Intersection Points

This command is used to create points at all of the intersections between selected linework entities.
Prompts

Select lines and polylines to process.
Select objects: Specify opposite corner: pick objects

Pull down Menu Location: COGO > Locate at Intersect

Keyboard Command: ADDINTPTS

Prerequisite: None

Bearing-Bearing Intersect

This command locates a point at the intersection of two lines. The lines can be defined by picking two points, selecting a line or typing in a bearing. After the lines are defined a point symbol is located at the point of intersection. When a grid projection is defined in Drawing Setup, there is a prompt for whether to use the mean, forward or back geodetic bearing.

Prompts

[Enter] to use preview point or select 1st Base point?
Options/<Pick point or point number>: press Enter
Define 1st angle by (Line/Points?Right/Azimuth/Bearing) <Bearing>: L
Select Line or Polyline that Defines 1st Bearing: select
Enter 1st Offset Distance <0.0>: select
2nd Base point?
Pick point or point number: pick a point
Define 2nd angle by (Line/Points/Right/Azimuth/Bearing) <Line>: P
[Enter] to use preview point/or pick 1st point that defines 2nd bearing,
Pick point or Point number: pick point
2nd point that defines 2nd bearing?
Pick point or Point number: pick a point
Enter 2nd Offset Distance <0.0>: press Enter
Enter/<Select text of elevation>: select
The point is then located at the computed point of intersection.

Bearing-Bearing Intersect example

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bb
Prerequisite: None

Create Points from Entities
This command will create Carlson points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file. The Draw New Points option creates point entities in the drawing. Otherwise, the new points are only stored to the coordinate file. The Draw Existing Matched Points option applies to the Avoid Duplicates option for the case when a duplicate is found in the coordinate file and not yet drawn.
Routine begins with this dialog

After clicking OK on the first dialog

**Prompts**

*Create Points From Entities Dialogs* Choose settings

*Select arcs, circles, faces, points, text, lines and polylines.*

*Select objects:* *pick entities*
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pulldown Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities

### Distance-Distance Intersect

This command creates a point at the distance-distance intersection from two base points. The program prompts for two distances and two base points. The two possible intersections (A,B) are shown on the screen. You can either pick near the desired intersection or type in the letter A or B. The A intersection is clockwise from the first point. The Options choice brings up a small dialog that allows you to be prompted for angle method or for offsets, or both.

### Prompts

Select 1st base point  
Options/<Pick point or point number>: 1  
Points/<1st distance>: 46.72  
Enter 1st Offset Distance <0.0>  
Select 2nd base point  
Pick point or point number: 2  
Points/<2nd distance>: 38.96  
Enter 2nd Offset Distance <0.0>: press Enter  
Pick near solution or Enter [A] or [B]: pick a point
Bearing-Distance Intersect

The Bearing-Distance Intersect command prompts the user for a base point from which the known bearing intersects. It then defines the bearing by one of three methods. The bearing can be defined by picking two points, selecting a line with the same bearing or by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for a base point from which the known distance radiates. After entering the known distance a circle is drawn radiating from the selected base point, and a line defined by the bearing is extended to intersect the circle. The user then picks the correct point for the solution desired and a point symbol is located at the selected intersection. The command then erases the temporary circle and line. The Options choice allows you to be prompted for angle method or for offsets, or both.

Prompts

[Enter] to use preview point or select known Bearing base point
Options/Pick point or point number: pick point
Define 1st bearing by (Line/Points/Azimuth/Bearing)<Bearing>: l
Select Line or Polyline that Defines Bearing: pick entity
Enter 1st Offset Distance <0.0>: press Enter
Known distance base point.
Pick point or point number: pick point
Points/<Enter Distance>:40.41
Enter 2nd Offset Distance <0.0>: press Enter
[int on] Pick Intersection point ([Enter] to cancel): pick point
Enter Point Number <55>: press Enter This prompt appears only if Automatic Point Numbering is turned off.
See Point Defaults
Enter Point Symbol Number <4>: press Enter This prompt appears only if point symbol prompting is turned on.
Symbol number 4 is located at the computed coordinate and labeled point number 55.
When Options (O) is selected

Pulldown Menu Location: COGO > Locate at Intersect

Keyboard Command: bdint

Prerequisite: None

2 Point - 2 Point Intersect

This command is similar to Bearing-Bearing Intersect except that in this command bearings are defined by specifying two point numbers. In the example shown below, the first two points specified are 3838 and 3839, the second pair are 3841 and 3840. Point 3842 is located at the intersection.

Prompts

Specify 1st base point.
Pick point or point number: 3838
Specify 2nd point that defines 1st direction.
Pick point or point number: 3839
Specify 2nd base point.
Pick point or point number: 3841
Specify 2nd point that defines 2nd direction.
Pick point or point number: 3840
Select/<Enter Point Elevation>: Enter value
**Pulldown Menu Location:** COGO > Locate at Intersect

**Keyboard Command:** bbint2

**Prerequisite:** None

### Resection

This command calculates point coordinates given the angle and distance from two or three reference points. The Z coordinate can also be calculated in addition to the X,Y. If you only need the 2D solution, then enter the instrument and rod heights as 0.0, the zenith angle as 90 and the distance as the horizontal distance. The reference points are specified by point number. These reference points need to be stored in the current coordinate (.CRD) file before running this command.

After entering the reference point, there is a dialog to enter the horizontal angle, zenith angle and slope distance. The horizontal angle is the horizontal azimuth or angle right from the unknown point to the reference point. In the example, the backsight azimuth is 0 (due north), but this is not a requirement since the backsight can be any angle. The program calculates the coordinate by averaging the distance-distance and angle-angle solutions. Since there is redundant data, the final calculated coordinate will differ slightly from the individual measurements. For example, in a 3-point resection, there are two different distance-distance solutions (between the first-second point and between the second-third points). The program reports the difference between the final coordinate and the individual solutions as the residuals which act as an indicator whether the data is good. High residuals suggest a problem with the input data. In the dialog that displays the final coordinates and residuals, there is a button to store the coordinates to the current coordinate (.CRD) file with a specified point number.

In the first Resection dialog box, you can choose to use two or three reference points.

![Resection Dialog Box]

In the second Resection dialog box, you assign the reference point.
**Point:** You must enter the point number of your reference point. These reference points need to be stored in the current coordinate file before you run this command.

**Inst. Height:** You must enter the instrument height.

**Target Height:** You must enter the target height.

If you need only the 2D solution, then enter the instrument and target heights as 0.0.

In the Manual Read dialog box, you must specify parameters for the calculation.

**Horizontal Angle:** You must enter a horizontal angle from the resection to the reference points. The horizontal angle is the horizontal azimuth, or angle right, from the unknown point to the reference point.

**Zenith Angle:** You must enter a zenith angle. For a 2D solution, set the zenith angle to 90 degrees.

**Slope Distance:** You must enter a slope distance from the reference points to the resection.

You are prompted for additional reference points and parameters.

The Resection Calculation dialog box that displays the final coordinates and residuals. You can select the option to store the coordinates in the current coordinate file with a specified point number.
Benchmark

This command is similar to the data collector routine, where a measurement with a total station is taken from an unknown elevation to a known elevation foresight. The unknown elevation of the occupied point is then calculated based on the measurement. Either the Occupied Elevation or the Instrument Height can be calculated. Note that a check box is located at the bottom of the dialog box to "Store Elev To Occupied Pt". This will automatically change the elevation of the occupied point.

Prompts

Coordinate File to Process dialog If required, this dialog will appear and you must select a file.
Benchmark dialog Fill in variables, click Calculate

Numeric Pad COGO

Using only the keys on the numeric pad, this command does several COGO commands. The program cycles through six prompts. Only respond to the prompts that apply and the program will perform the correct action. The prompts are: First point? First angle? First distance? Second point? Second angle? Second distance?

To inverse, give a first point and second point.
To traverse, give a first point, first angle and first distance.
To do bearing-bearing intersect, give a first point, first angle, second point and second angle.
To do *bearing-distance intersect*, give a first point, first angle, second point, and second distance. Or give a first point, first distance, second point, and second angle. The point is calculated at the closer intersection.

To do *distance-distance intersect*, give a first point, first distance, second point, and second distance. The point is calculated at the first intersection going clockwise from the first point's distance circle.

Points can be screen picked or entered as point numbers that reference the current coordinate file. The last point is used as a default when you press Enter at the prompt for the first point. Which point is being used is indicated by a ghost arrow pointer.

Angles can be specified by picking two points or entering an angle code which begins with a single digit code followed by the degrees and the minutes and seconds after a decimal point. The digits codes are (1 - Northeast, 2 - Southeast, 3 - Southwest, 4 - Northwest, 5 - Azimuth). For example, Northwest 50d10'2" would be 450.102.

Distances can be specified by picking two points or entering the distance value.

**Prompts**

Enter coords/Quit/ <Pick 1st point or point number> : 5
Pick or Type 1st Direction by 2 Points: 145.0135 (Northeast 45d1'35'")
Pick or Type 1st Distance by 2 Points: 50.0
A point is created from the values for this traverse. The prompts for the second point don't appear because all the information for this action is entered.

Enter coords/Quit/ <Pick 1st point or point number> : press Enter to use the point created by the traverse.
Pick or Type 1st Direction by 2 Points: 50.0
Enter coords/Quit/ <Pick 1st point or point number> : 4
Enter/Pick 2nd Direction by 2 Points: press Enter
Enter/Pick 2nd Distance by 2 Points: 75.0
This creates a point by distance-distance intersect.

Enter coords/Quit/ <Pick 1st point or point number> : Q

Pulldown Menu Location: COGO
Keyboard Command: ccogo
Prerequisite: None

**Point on Arc**

This command locates a point on an arc. You can select an arc entity, an arc polyline segment or enter three points to define an arc. After the arc is defined, the screen preview arrow shows the occupied point and the distance to solve for is entered. The command then displays the curve information and locates/inserts a point symbol at the computed point. When prompted for the distance, use a positive value if the distance is from the 1st endpoint (PC the one highlighted by the screen preview arrow) and a negative value if from the 2nd endpoint (PT).

**Prompts**

Define arc by, Points/ <select arc or polyline> : pick arc or polyline arc segment Pick a point on the arc somewhere near it's midpoint. The preview arrow points to the 1st endpoint.
Precede distance with minus sign if distance from 2nd endpoint.
Distance along arc from 1st point: 100
The command then plots a point at the computed distance.
Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptarc
Prerequisite: None

Divide Between Points
This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

Prompts
Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1

PointNo. Northing(Y) Easting(X) Elev(Z) Description
1 4252.76 4158.32 0.00

Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: hit Enter
The command then locates two points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divlin
Prerequisite: 2 points

Divide Along Entity
This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

Prompts
Interpolate Elevations [Yes/<No>]: press Enter
Select Entity to Divide: pick point on entity
Number of Divisions/Segments: 15
The command then locates 14 points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations

Interval Between Points
This command creates points by interpolating at a horizontal distance interval between two control points. There is an option for whether to interpolate the elevation or use zero for elevation. The point style and whether to prompt for a description is set in Point Defaults.

Prompts
Interpolate elevations [Yes/<No>]? press Enter
Point to interpolate from?
Pick point or point number: pick a point
Point to interpolate to?
Pick point or point number: pick a point
Interval Distance: 50

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Commands: ptintpt
Prerequisite: None

Interval Along Entity
This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example, you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. When Create Point at Endpoint is checked, points will also be located at the endpoints of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

For improved descriptions on the points, there is an option, in this main dialog, allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that
allows you to set the same description to all of the points. For more options related to points, see *Point Defaults* under the Points pulldown.

Create Points at Endpoints turned on

**Prompts**

*Select entity near endpoint which defines first station.*

[nea on] Select Entity to Interpolate Points: *select entity*

[nea on] Select Entity to Interpolate Points: Locating 13 Points

The command locates points along the selected entity.

**Pulldown Menu Location:** COGO > Interpolate Points

**Keyboard Command:** ptint

**Prerequisite:** An entity
Line by Angle-Distance

This command draws a line from an occupied point at a given angle and distance, where the angle format supports the standard 1-9 angle-bearing codes. It holds the current occupied point and calculates a line by angle-distance to each entered point. As for the angle formats, the Options choice allows for angle right, azimuth only or prompt entry (Right/Azimuth/Prompt) methods. The Prompt method allows you to enter the 1-9 angle-bearing codes.

Prompts

Occupied Point ?
Pick point or point number: pick point

Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <90.0000>: 112.3024
Points/<Distance>: 290
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <112.3024>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? R
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <112.3024>: 88
Points/<Distance>: 300
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <88>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P
Exit/Options/Points/Angle-Bearing Code <7>: Enter
Enter Angle (dd.mmss) <88>: 31.4340
Points/<Distance>: 419
Exit/Options/Points/Angle-Bearing Code <7>: E

Pulldown Menu Location: COGO
Keyboard Command: travline
Prerequisite: None

Tangent Line from Circles

This command draws a line that is tangent to two circles or arcs. The circles can be defined either by picking the radius point and entering the radius, or by selecting circle or arc entities. The tangent line can be drawn to either outside on the left or right side, or across the middle between the circles from left to right or from right to left. The line and the circles are drawn in the current layer. There is also an option to create two points at the ends of the tangent line.

Prompts
Tangent Line From Circles dialog
Pick center point of first circle: pick a point
Pick first radius: 25
Pick center point of second circle: pick a point
Pick second radius: 35
Pulldown Menu Location: COGO
Keyboard Command: linecircle
Prerequisite: None

Building Offset Extensions

This command is used to calculate building corner offset points that are extensions of the building faces. This command uses building perimeters that are drawn as closed polylines. The point are stored to the current coordinate file and draw on the screen. There is a dialog for setting the parameters. The Offset Amount is the distance that the offsets are extended past the end of the building line. The Starting Point Number is the point number to begin storing from. The Point Description and Elevation are assigned to all the new points and the Point Layer is used for all the drawn points. Offset points are always created as extensions of the building lines at the corners. Offset points can optionally be created at the diagonals of corners and across to the other side of the building for inside corners. In the example show here, points 101, 103, 104, 106, 107, 109, 110, 112, 115, 117, 118 and 120 are corner extension offset points. Points 102, 105, 108, 111, 116 and 119 are diagonal points. Points 113 and 114 are across building points.
Prompts

Building Offset Extensions dialog
Select building perimeter linework.
Select objects: make selection

Pulldown Menu Location: COGO
Keyboard Command: bldg.pnts
Prerequisite: A polyline perimeter that represents a building

Radial Stakeout
This command creates a radial stakeout report using the current coordinate (.CRD) file. The program calculates the azimuth, angle right, horizontal distance and/or slope distance for a range of points relative to an occupied point and a backsight point.
**Occupied Point Number:** Specify the occupied point number X and Y values will fill in automatically.

**Backsight Point Number:** Specify the backsight point number X and Y values will fill in automatically.

**Maximum Hz Distance:** This is the maximum horizontal distance from the occupied point that the program will include in the report.

**Range of points to Compute:** Enter the range of points to be included in the stakeout report If you check Select Points from Screen, this option is unavailable.

**Select Points from Screen:** This option allows you to select from the screen the points to be included in the stakeout report.

**Number of Decimal Places:** Specify the display precision for the report.

**Report Options:** Specify the direction format that the report should use.

**Report Slope Distance:** When checked, the slope distance is included in the report in addition to the horizontal distance.

**Use Cut Sheet Format:** When checked, adds columns to the report for Description, Hub Elev, and Elevation.

---

**Sample radial stakeout report:**

**Radial Stakeout**

**Occupied Point**

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>7137.7248</td>
<td>9016.1417</td>
<td>500.000</td>
</tr>
</tbody>
</table>

**Backsight Point**

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>7075.7408</td>
<td>8875.7884</td>
<td>500.000</td>
</tr>
</tbody>
</table>

**Backsight Azimuth=** 246.1021

PtNo. Azimuth  AngRight HzDist  North(y)  East(x)  Elev(z)

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>Azimuth</th>
<th>AngRight</th>
<th>HzDist</th>
<th>North(y)</th>
<th>East(x)</th>
<th>Elev(z)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>261.0258</td>
<td>14.5237</td>
<td>74.061</td>
<td>7126.2022</td>
<td>8942.9830</td>
<td>500.000</td>
</tr>
<tr>
<td>4</td>
<td>262.4347</td>
<td>16.3327</td>
<td>113.032</td>
<td>7123.4208</td>
<td>8904.0181</td>
<td>500.000</td>
</tr>
<tr>
<td>5</td>
<td>281.1809</td>
<td>35.0748</td>
<td>137.858</td>
<td>7164.7435</td>
<td>8880.9572</td>
<td>500.000</td>
</tr>
<tr>
<td>6</td>
<td>301.4512</td>
<td>55.3452</td>
<td>82.296</td>
<td>7181.0342</td>
<td>8946.1639</td>
<td>500.000</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** COGO

**Keyboard Commands:** radstake, rs
**Section Subdivision**

This command calculates and stores unknown corners that can be calculated given the data specified. The Section number, Township and Range must be entered first. Next, specify the point IDs of corners that have been located in the field.

**Note:** The choices in the **Specify Field Located Corners** section of the dialog merely make it more convenient to enter the Section & Quarter corners and the 1/16th corners. This choice allows you to enter the corners in order by just typing the point ID of a corner then just press enter to move to the next corner. You may enter any type of corner located in the field by changing the types of corners selection in the **Specify Field Located Corners** section.

Next, enter the government chainages as required.

The calculated points will be plotted on the screen and saved to the coordinate file.

For each calculated corner, the **Saving Point** dialog box will be displayed. Depending on the point default settings, this dialog may allow you to accept or change the default point ID. Also, Depending on the point default settings, the description and elevation may also be changed or accepted.

**Pulldown Menu Location:** COGO > Section Corners

**Keyboard Command:** cg_section_subd

**Prerequisite:** Coordinate File

**GLO Corner Proportioning**

The GLO Corner Proportioning commands calculate section and 1/4 section corners by one, two, three or four way control. GLO plats are the official plats of the U.S. Government Land Office (GLO) executed after July 1946. The
One Way Control

This routine calculates section and 1/4 section corners by one way control. First, enter the point number for Point A. This number can be entered manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Bearing from A to B can be entered manually or by using the Pick radial button to pick from the screen. The distance from A to X can be specified in the same manner as above. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well.

Prompts

GLO Proportioning One Way Control dialog

Saving Point dialog
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning

Keyboard Command: cg_glo_one_way

Prerequisite: A coordinate file

Two Way Control

This routine calculates section and 1/4 section corners by two way control. Enter the point numbers for Point A and B. These numbers can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Record Chainages from A to X and from A to B can be entered manually or by using the Pick radial button to pick from the screen. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field with be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Two Way Control dialog
Saving Point dialog

Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning

Keyboard Command: cg_glo_two_way

Prerequisite: A coordinate file

Three Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts
GLO Proportioning Three Way Control dialog

Saving Point dialog

Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_three_way
Prerequisite: A coordinate file
Four Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field with be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Four Way Control dialog

Saving Point dialog:
**Pulldown Menu Location:** COGO > Section Corners > GLO Corner Proportioning  
**Prerequisite:** A coordinate (CRD) file  
**Keyboard Command:** cg_glo_four_way

### Geodetic Single Proportion Line Division

This command breaks a line into two lines that have the same mean geodetic angle. The length of the first new line is proportional to the specified part distance relative to the total distance. Before running this command, the grid projection must be set under Drawing Setup.

**Prompts**

- **Select a line near beginning point:** *pick a line*
- **Enter Record Part Distance [Meters/<Feet>/Chains]:** 500  
- **Enter Record Total Distance [Meters/<Feet>/Chains]:** 2000

**Pulldown Menu Location:** COGO > Section Corners > Geodetic  
**Prerequisite:** A line  
**Keyboard Command:** geosprop

### Geodetic Double Break

This command breaks two crossing lines at their intersection such that the two segments of the first line have the same geodetic mean bearing and the two segments of the second line have the same geodetic mean bearing. Before running this command, the grid projection must be set under Drawing Setup.

**Prompts**

- **Select 1st line to split:** *pick a line*  
- **Select 2nd line to split:** *pick a line*

**Pulldown Menu Location:** COGO > Section Corners > Geodetic  
**Prerequisite:** Two crossing lines
Keyboard Command: geodbk

**Geodetic Middle Break**

This command breaks a line into two lines that have the same mean geodetic angle and same geodetic length. Before running this command, the grid projection must be set under Drawing Setup.

**Prompts**

Select line to split at geodetic midpoint: *pick a line*

Pulldown Menu Location: COGO > Section Corners > Geodetic

Prerequisite: A line

Keyboard Command: geomid

**Solar Observations**

This feature calculates true north and/or grid north bearings by solar observation. It uses the Local Hour Angle (LHA) method. The routine calculates Ephemeris data, thus alleviating the necessity of obtaining a Solar Ephemeris. The True North option calculates the true north bearing to mark. This option requires no zone/ellipsoid information. The True North & Grid North option calculates both true north and grid north bearings to north. The convergence angle is also shown.

Note: There is a description of solar observation field procedures at the end of this section.

**True North Prompts**

Calculate true north, or true north and grid bearing (<True north>/Grid Bearing: *type T, press Enter*

Choose field method (Leading edge/Trailing edge/<Center>): *choose method, press Enter*

If a Roelofs prism is being used, the Center Method should be selected. If not, select one of the other options. The Trailing Edge Method is the more popular of the two remaining methods.

Date of observation as MM/DD/YY or MM-DD-YYYY: For example 04/08/03.

Enter latitude of instrument point as DD.MMSS: For example 36.0545

Enter longitude of instrument point as DD.MMSS:

The following input loop will begin:

Obs. #1 - Time of observation as HH.MMSS: For example 15.3030

Enter angle to mark as DD.MMSS: Angle in the instrument when backsighting the mark.

Enter angle to sun as DD.MMSS: Clockwise angle from mark to sun.

The angle to the mark always has a default value of the last entered Angle to Mark. Each observation is numbered and the true bearing to the mark will be calculated. There is not limit as to the number of observations that can be made from a setup. After data entry is complete, press Enter.

The following options appear:

[Edit/Ok/Quit] <O>:

If you choose Edit, you will have the following options:

ADD/Change/Delete/eXit:

Add: Allows for addition observation data entry.

Change:

Allows editing of existing data. When selected a prompt for Enter observation to change will be displayed. Choose which observation number to edit. You will then be prompted with the initial input prompts for the observation
Again. The original input values will be the default values for each prompt. To change the value, simply enter new data.

**Once Delete:** This will delete the specified observation data. Choose the observation number to delete.

**eXit:** This exits the change routine.

If you type 0 and Enter or just enter for **OK**, the bearings from all the observations will be averaged and shown as well as the True Bearing. For example:

**No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark**

1 12.3030 0°00'00'' 20°00'00'' N 73°05'43''E  
2 12.4456 0°00'00'' 21°00'00'' N 74°17'15''E  
Average True Bearing: N 73°41'29''E

**True North & Grid Bearing Prompts**

**Type of calculation [True-north/true-north-and-Grid-bearing]** <T>: G

The following dialog will be displayed:

![Solar Observations - State](image)

Select the state in which the observations were made. All fifty states are available, as well as PR for Puerto Rico and UTM for Universal Transverse Mercator.

If the state is divided into zones, you will be prompted for the zone you are working in.

**Enter zone (N,S):** Enter the zone.

If you are using a UTM, you will see the following prompt:

**Enter ellipsoid to use [GRS-1980/Other]** <G>: 
Type "R" and Enter or just Enter for Reciprocal flattening, "S" and Enter for Semi-minor axis, or "E" and Enter for ellipsoid ECC squared.

if you typed O and Enter for **Other**, you will see the following prompt:

**Ellipsoid constant [Reciprocal flattening/Semi-minor axis/ellipsoid ECC squared]** <R>: 
Depending on what was entered at the last prompt you will see one of the following prompts: **Enter reciprocal flattening constant**: Type the constant.

**Enter semi-minor axis**: Enter the axis.

**Enter ellipsoid ECC squared constant**: Enter the constant.

After entering the zone and ellipsoid information (if applicable) the date, latitude, longitude and time input loop will begin (as described above for the True North calculation).

After data entry is completed the [**Edit/Ok/Quit**] <O>: prompt will be displayed (see the True North section for more details on this prompt).

If you type 0 and Enter of just Enter for Ok, the information for all the observations is displayed along with the
Average True Bearing, Average Grid Bearing and the Convergence Angle as follows:

<table>
<thead>
<tr>
<th>No.</th>
<th>Time</th>
<th>Angle-@-Mark</th>
<th>Angle-to-Sun True-Brg-to-Mark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>12.222</td>
<td>0°00'00''</td>
<td>20°00'00'' N 72°57'31''E</td>
</tr>
<tr>
<td>2</td>
<td>12.444</td>
<td>0°00'00''</td>
<td>22°00'00'' N 74°20'51''E</td>
</tr>
</tbody>
</table>

Average True Bearing: N 73°39'11''E
Average Grid Bearing: N 72°15'12''E
Convergency Angle: 1°23'59''

Field Procedures for the Local Hour Angle (LHA) method

This section explains Universal Time and then explains two ways of pointing, Trailing Edge Tangency and Roelofs Prism.

**Universal Time**

The Universal Time can be obtained on certain radio bands. On the radio channel there will be a signal beep every minute. Set a watch to the Universal Time or, when in the field, start a stopwatch at the beep (for a known Universal Time).

In order for the solar observation method to produce accurate results, it is essential that you record the precise Universal Time for an observation. Thus, when making the field observations, record the stopwatch elapsed time in order to calculate the Universal Time or, if you set your watch to Universal Time, record the time directly.

**Trailing Edge Tangency**

While pointing at the ground mark, set the horizontal circle to read about 00-00-30, perfect pointing. With the scope direct, record the horizontal circle reading to the mark.

Attach the eyepiece filter and sight the sun. After locating the sun, do the following:
- Set the horizontal reticle line near the center of the sun’s image with the vertical reticle line leading the trailing edge of the sun (slightly right for a direct image).
- Clamp the horizontal motion and watch the image of the sun as the trailing edge approaches tangency with the vertical reticle line.
- Stop the timer at the time of tangency.
- Record the time and the horizontal circle reading.
- Repeat the pointing for a total of four pointings in the direct position.
- Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
- Unclamp the horizontal motion, point at the ground mark with the instrument reverse and record the horizontal circle.
- The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Roelofs Prism**

Attach Roelofs prism and sight the sun (you can center the shadow of the telescope between the standards as an aid in locating the sun). Be sure that the hinged tube is closed when pointing at the sun. After locating the sun through the scope, do the following:
- Rotate the prism until the four overlapping images of the sun are symmetrical with the instrument's reticle lines.
- Point on the ground mark with the instrument direct and the Roelofs prism tube swung open, perfect pointing on the ground mark. Record the horizontal circle reading to the mark.
- Point at the sun with the prism closed. After locating the sun, do the following:
- Set the horizontal reticle line near the center of the sun's pattern with the vertical reticle line leading the center of the moving pattern (slightly to right of the sun for direct optics).
- Clamp the horizontal motion and watch the pattern move to the point of coincidence. This is the intersec-
tion of the vertical reticle line with the apex of the small dark square formed in the center of the pattern by the overlapping parts of the four images formed of the sun.

Stop the timer at the moment of coincidence.

Record the time and the horizontal circle reading.

Repeat the pointing for a total of four readings in the direct position.

Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.

Unclamp the horizontal motion, point on the ground mark with the instrument reversed and record the angle on the horizontal circle.

The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Pulldown Menu Location:** COGO

**Keyboard Command:** cg_solar_obs

**Prerequisite:** None

## Triangle Solutions

Triangle Solutions solves for the remaining sides and angles of a triangle given the known side and angles. The upper case letters A, B and C represent the distances. The lower case letters a, b and c represent the angles. Distance A is the leg of the triangle opposite the angle 'a'. Likewise, distance B and C are the legs opposite the angles of 'b' and 'c', respectively. Enter any three known values of the six possible parameters and the three unknowns will be calculated and displayed. If you enter three angles, you will be shown proportional distances since there is an infinite number of distances that would solve a three angle triangle.

In this example, The sides A & B are known as is angle 'a'. After entering the three parameters, press the Solve button and the remaining three will be calculated and shown. The area in acres or hectares and feet or meters will also be calculated and shown. Press clear to enter data on a new triangle after the triangle has been solved. The solution for each triangle area is then displayed at the command line. You may press F2 to display the command line window and view the results.

Side A Side B Side C Angle a Angle b Angle c
Best Fit Point

This command calculates the average point from a selection of input points and reports the residual statistics. The input points can be specified by point number, by point group or by screen selection. The program displays the input points with residuals in a dialog where you can toggle on/off whether to include points in the average using the Process On/Off button. The Remove button removes a point from the average and the residual report. There is an option whether to output the average point to the current coordinate file. The option to delete all the input points applies when there are several points that are meant to be the same point and you want to replace them with a single averaged point. The command shows a report of the input points, residuals and average point.

Prompts

Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software Points.
Select objects: pick points
Best Fit Dialog

Sample Report:

Source Coordinates
Point# Northing Easting Elevation Residual
1  4024.912  5205.108  542.200  131.567
2  4062.104  5173.570  543.100  147.733
3  4126.711  5180.822  543.700  142.100
...  

Residuals Standard Deviation: 37.128
Average Residual: 107.188
Average Point: 4091.142, 5317.562, 558.855

Pulldown Menu Location: COGO
Keyboard Command: bfitpt
Prerequisite: Two or more points

Best Fit Circle
This command draws a least-squares best-fit circle based on points on the perimeter. The program handles four or more perimeter points. A design point for the circle center can optionally be specified as a reference to compare with the best-fit center in the report. The report shows the residuals for each point, the residuals standard deviation, the difference between the design point and the circle center, and the circle parameters. The residuals are calculated as the perpendicular distance from the point to the circle. The best-fit circle can be calculated in 2D or 3D. In 2D mode, the elevation of the points is not used. In 3D mode, a best-fit plane is calculated for the points. Then the points are projected onto the plane and the best-fit circle is calculated on this plane. Then the resulting circle is projected back into world coordinates and drawn as a 3D polyline with short chords to represent the 3D circle since CAD doesn't support a 3D circle entity. Applications for 3D circles are tunnel sections and architectural arches.

After specifying the points, the program calculates the best-fit circle and shows the results in the dialog show here. You can toggle each point for whether to include in the calculations. You can also modify the radius.

Prompts

Create 2D or 3D circle [<2D>/3D]? press Enter
Select points from screen or by point number [<Screen>/Number]? N
Point numbers: 2-6
Point numbers (Enter to continue): press Enter
Enter design center point# (Enter for None):

Sample Report:

Source Coordinates
Point# Northing Easting Residual
2 5253.198 5070.233 0.126
3 5246.623 5084.077 0.045
Residuals Standard Deviation: 0.174

Circle Center: 5242.678,5073.785 Radius: 10.977
Design Center Point#: 1
Design Center: 5242.718,5073.688
Center Distance Difference: 0.105

Pulldown Menu Location: COGO
Keyboard Command: bfitcir
Prerequisite: Four or more points

Best Fit Centerline
This command processes a group of points by screen selection or point number range, and then computes the best fitting centerline by least squares. Each line segment in the centerline is calculated by the best-fit line method and each arc segment is calculated by the best-fit arc method. The line and arc segments are then made to be tangential.

In the process options dialog, the Snap Tolerance is the max offset from the point to the line or arc segment in order to be counted as part of that segment. The Max Radius controls the maximum radius for arc segments that the program will fit to the data.
The residual for each point is the perpendicular distance from the point to the best-fit centerline. The results are shown in a dialog and you can toggle each point for whether to include in the calculations. Points that are toggled off are not used for calculating the centerline but are still used in the residual report. The Remove function removes the point from both calculation and residual reporting.

![Best-Fit Centerline dialog box](image)

### Prompts

Select points from screen or by point number [Screen/Number]? S
Select Carlson Software Points.
Select objects: *pick the centerline points*

![Point selection](image)

### Pulldown Menu Location

COGO

### Keyboard Command

`bestcl`

Prerequisite: Group of points to sample

### Best Fit Line by Average

This command will fit a line from a starting point by sampling a group of points. The routine averages the coordinates of the sampling group then draws the best-fit line. The program generates a report of the residuals, standard deviation, line bearing and line distance. The perpendicular distance from each point to the line is reported as the residual.
Screen selection of lines almost in line with one another

Sample report of Best Fit Line by Average with a different group of points

Prompts

Starting point?
Pick point or point number: pick starting point
Select points from screen, group or by point number [Screen/Group/Number]? press Enter
Select points.
Select objects: select group of points Select points using Window or Crossing. The line is then drawn to the computed point.

Pull-down Menu Location: COGO
Keyboard Command: bfitlin
Prerequisite: points to sample

Best Fit Line by Least Squares

This command will sample a group of points by screen selection or point number range, and then compute the best fitting line by least squares. There are options to best fit with nothing held (None), to best fit by holding a point, and to best fit by holding a bearing. All three options are shown below in the graphic. When holding a point, you are prompted to enter the weight for the point. In this example, a weight of 1000 caused the line to pass to within 0.025 of point 111. With a weight of 5000, the line passed to within 0.005 of point 111. Increase the weight accordingly to obtain the desired precision. When holding a bearing such as N45E, you are prompted to enter the bearing in the form QDD.MMSS (e.g. 145.0000 or just 145). The program generates a standard report. The residual for each point is the perpendicular distance from the point to the best-fit line.

After specifying the points, the program calculates the best-fit line and shows the results in the dialog show here.
Prompts

Select points from screen, group or by point number [Screen>/Group/Number]? S

Select Carlson Software Points.

Select objects: pick the five points

Point numbers (Enter to continue): press Enter

Parameter to hold [None>/Point/Bearing]: P

Enter point number to hold: 111

Enter weight for point: 5000

Sample Report:

Best Fit Line By Least Squares
Holding point 111: (5227.721, 5149.482)

Coordinate File: c:\data\interval.crd

Source Coordinates
Point# Northing Easting Residual
109 5103.542 5182.098 10.050
110 5114.634 5191.928 6.921
111 5149.482 5227.721 0.005
112 5178.703 5268.237 0.400
113 5201.666 5312.602 8.129

Residuals Standard Deviation: 6.559

Bearing: N 53°44'07'' E
Distance: 163.266

Pulldown Menu Location: COGO
Keyboard Command: bfitlinelq
Prerequisite: Group of points to sample

Area/Layout Menu

This chapter provides information on using the commands from the Area/Layout menu to calculate and label areas, and also to set and define lots. Commands for designing and drawing more complex configurations, such as cul-de-sacs and intersections, are available here as well.
Area Defaults

This command allows you to specify default settings for area labeling. The Area Defaults dialog is divided into 3 tabs. The first is the Label Fields and Settings tab. The top portion of the Label Fields and Settings tab contains two listboxes which are used to control which of the possible ten area fields will be used for area labeling. You use the Add and Remove buttons to control which fields will be included in area labels. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

When a grid projection is defined in Drawing Setup, the Available Fields will include geodetic areas where the areas are adjusted by the projection. The Base Z from Drawing Setup is used for the elevation factor for this adjustment.
Field Settings Dialog: To control the appearance of the fields in the drawing, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

User Defined: The Field "User Defined" can be added to place a custom fixed label in all areas. To control the value and appearance of the custom label in the drawing, use the Edit button to edit the "User Defined" item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog. In this case the "Value" setting becomes the custom label.

Scaled labels: The "Scaled Sq. Feet", "Scaled Sq. Meters", "Scaled Acres" and "Scaled Perimeter" fields can be used to include area labels that are scaled based on Drawing Setup "Report Scale Factor".
**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically (see below for example of results of using a prefix with square feet and acres).

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/-:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

Below the Available and Used Fields lists the following items for further controlling area label generation:

**Use Commas in Labels:** This allows you to use commas in the area labels.

**Use MText:** Check this box to turn on the use of MText for area labels. If this is checked all area labels will be grouped into as few MText entities as possible. Area labels with different text styles, justification or layers will not be combined into the same MText entity.

**Erase Previous Labels:** When checked, previous area labels for the area being relabeled will be erased.

**Label Placement:** When auto placement of area labels is used, the labels can be placed either at the centroid of area or at the rear side. This is accomplished by selecting either the Center or Rear Side radio button, respectively. When Center is selected the user can choose to have the labels oriented according to the side lines of the area by checking the Align By Sides checkbox. When either Align By Sides or Rear Side is selected, the checkbox Flip Text for Twist Screen can be selected to have the label rotated 180 degrees to present it in the best reading orientation relative to the current Twist Screen rotation setting.

**Draw Symbol Around Lot Description:** When the Lot Description field is included in the Used Fields list, the user can check this checkbox to have a symbol drawn around the Lot Description field. When this box is checked, you specify the symbol name in the Symbol Name field or click on the current symbol (drawn to the right) to graphically choose the desired symbol. You specify the layer by entering the name in the Layer box or by clicking on the Select button to choose from a dialog that presents all known layers.

**Symbol Buffer Offset:** By default, the symbol will be automatically scaled according to the text length and size of the Lot Description value for the area. For additional control of symbol scaling, the user can enter a number in text size units in the Symbol Buffer Offset box. This value will be added to the automatically generated default scaling value.

**Avoid Label Overlap:** If this box is checked the area labels will be checked for overlaps after they are generated. Please see the Overlap Manager documentation for more information.

**Overlap Settings:** Click this button to go to the Avoid Label Overlaps dialog where you can review or modify the Overlap Manager settings. Please see the Overlap Manager documentation for more information.
Table Process Settings Tab:

**Use Area Tables:** Use this control to determine whether area labels are sent to a table or not. Options are "Never", "Always" or "By Scaler".

**To Table Area:** When the user has selected "By Scaler" in the "Use Area Tables" list this item is enabled. When "By Scaler" is selected and the area is less than this minimum, the area label is sent to a table.

**Area Reference Numbering:** There are three different methods for setting the reference number: Next Available will automatically use the lowest available number. Specified With Prompt will prompt you for a number for each area. Specified with Auto Numbering will automatically use the lowest available number starting with the specified number.

**Auto Place Table References:** When checked, will automatically place the area reference label according to the settings for the area labels as specified in the Label Field and Settings tab (see above). Otherwise you will be prompted to pick each label location manually.
Area Commands Tab:

**Max gap to join:** You use this option during *Area by Lines & Arcs* command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.

**Prompt whether to retain polylines created by Area by Interior Point:** When checked the user will be asked whether to retain the polylines created by the "Area by Interior Point" command.

**Polyline Layer:** Will be enabled when "Prompt whether to retain polylines created by Area by Interior Point" is checked to allow the user to select the layer that any such created polylines will be placed in.

**Load/Save:** These buttons save and recall all the Area Default settings to a .ARS settings file.

**Tip:** Keep in mind that changes in Area Defaults, if changed from the Area/Layout pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.
The results of using a prefix with square feet and acres

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** defarea  
**Prerequisite:** None

---

## Inverse with Area

This command generates a report of the angle and horizontal distance between a series of points, and calculates the area of the closed figure defined by the points. Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error.

At the first command prompt, you can enter O for Options to bring up the command options. The Different Radius Tolerance checks that the distance between the PC and radius point and the PT and radius point match for curves. There is an option to report the distances in both feet and meters. The Use Report Formatter chooses between the standard report or customizing the report. You can also set the decimal precisions for the report and whether to report stations for the distances along the perimeter.

---

![Inverse With Area Options dialog box](https://example.com/inverse-area-options.png)

The area can be labeled in the drawing using the settings from the *Area Defaults* command. If you don't want to label the area, press Enter at the pick label point prompt. This command creates a polyline of the figure which can
be erased or kept in the drawing.

**Prompts**

Options/<Pick Starting point or point number>: pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): R for radius
Radius point number or pick point: pick a point
Curve direction [Left/<Right>]? press Enter
Pick End of Arc or point number (U-Undo,Enter to end): pick a point
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): pick a point
Point number (R-RadiusPt,U-Undo,Enter to end): pick a point
Point number (R-RadiusPt,U-Undo,Enter to end): pick a point
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
SQ. FEET: 27247.4 SQ. YARDS: 3027.5 SQ. MILES: 0.0
ACRES: 0.63 PERIMETER: 668.35
Pick area label centering point: pick a point
Erase Polyline Yes/No <Yes>: press Enter The command plots a polyline that represents the figure you defined if you want to keep the polyline respond with No.

Inverse with Area
CRD File> c:\data\newplat.crd
PNTNO BEARING DISTANCE NORTHING EASTING STATION DESC
903 4940.73 2490.40 0.00 StartPt S 48°43'58'' W 136.21 904 4850.89 2388.01 136.21 S 13°07'04'' E 155.56 905 4699.39 2285.57 155.56 S 26°34'02'' E 21.86 714.97 IP N 26°28'57'' W 125.87 909 4923.03 2656.69 840.84 N 83°55'30'' W 167.23 903 4940.73 2490.40 1008.07 StartPt
Closure Error Distance> 0.0000
Total Distance Inversed> 1008.07
AREA: 74664.6 SQ METERS

Pulldown Menu Location: Area/Layout
Keyboard Command: ia
Prerequisite: None

**Area by Lines & Arcs**

This command allows you to calculate the area of a perimeter or lot defined by lines, arcs, or polylines. Default settings for this command are set in Area Defaults. One of these settings is Max gap to join. If there is a gap greater than this value, the area is not reported, and the program will show where the gap is with a temporary X symbol. The area data shows up on the text screen. You can then choose to plot the area information to the drawing, or, by hitting Enter, just read it from the text screen.

Chapter 3. Survey Module
Prompts

Select lines & arcs or polylines of perimeter for area calculation.
Select Objects: select lines and arcs or polylines
Lines and arcs are then joined together and the area calculated.
Pick area label centering point (Enter for none): pick a point
The area is then plotted at the point selected.

Pulldown Menu Location: Area/Layout
Keyboard Command: joinarea
Prerequisite: Lines, arcs, or polylines to define the area

Area by Interior Point
This command calculates and labels the area of the perimeter surrounding a picked interior point. The Boundary Polyline command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use Area by Lines & Arcs for other applications. The settings for the area label and for whether to prompt to create a closed polyline for the area are under the Area Defaults command.

Prompts

Pick point inside area perimeter: pick a point
Pick area label centering point (Enter for none): pick a point
The area is then plotted at the point selected.

Pulldown Menu Location: Area/Layout
Keyboard Command: ptarea
Prerequisite: Set Area Defaults

Area by Closed Polylines
This command will calculate and report the area of single area and multiple area closed polylines. In the case of multiple areas, the user can choose to have the areas totaled (Total Multiple Areas) into a single result or to generate data for each area separately. Area by Closed Polyline will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in
the report. The plot of the area on-screen can be canceled if only the report is desired.

Prompts

**Select Area Polyline**: select the area polyline
SQ. FEET: 64862.9 SQ. YARDS: 7207.0 SQ. MILES: 0.0
ACRES: 1.5 PERIMETER: 1018.7
Pick area label centering point (Enter for none): pick a location

When auto-placing labels at the rear of lots or when aligning labels by the sides of the lot the user will also be prompted to pick one or more centerlines (**Select the Centerline Polylines**). The routine will find the closest centerline and use this to determine the location of the front and back corners of the area.

When additional interior text is selected, the standard report will include that text:

**Polyline Area 11/17/2004 12:49**
Polyline Area: 43560.0 sq ft, 1.00 acres
Polyline Perimeter: 838.35 ft
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.
Pulldown Menu Location: Area/Layout
Keyboard Command: plarea
Prerequisite: Set Area Label Defaults

**Digitize Areas**

This command allows for digitizing areas. This routine includes an option for drawing perimeter polylines.

Pulldown Menu Location: Area/Layout
Keyboard Command: dig_area
Prerequisite: A digitizer

**Label Last Area**

This command will label the last area calculated with one of the Area commands in the manner defined in the *Area Defaults* dialog. The command prompts for a point where the label will be centered.

**Prompts**
Lot Description \(<2>: 1\)
Pick area label centering point (Enter for none): \textit{pick a point}

Pulldown Menu Location: Area/Layout

Keyboard Command: \texttt{lastarea}

Prerequisite: Set \textit{Area Defaults}, and use one of the Area commands to calculate an area.

Area Table Defaults

This command allows you to specify table fields and format settings for area tables. Whether the Area Commands create an area table or label within the area is controlled by the Area Defaults command by the Use Area Tables setting. With the Area Defaults and Area Table Settings prepared, the various Area Commands will create tables according to the settings. When the Area By Closed Polylines routine is used to create the area table and the Link Linework With Labels option is on under Configure Carlson->General Settings, then the area table values are automatically updated when the polyline geometry is modified. Also, when using the Area By Closed Polylines command with the Lot Description field active for the table, the program prompts for an area description for each polyline. The rest of the area table fields are calculated from the polyline geometry.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
<th>Acres</th>
<th>Lot Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>574.43</td>
<td>20212.71</td>
<td>0.46</td>
<td>Park</td>
</tr>
<tr>
<td>A2</td>
<td>835.85</td>
<td>41989.21</td>
<td>0.95</td>
<td>Lot 404</td>
</tr>
<tr>
<td>A3</td>
<td>910.72</td>
<td>50710.66</td>
<td>1.16</td>
<td>Lot 405</td>
</tr>
</tbody>
</table>
The Area Table Defaults dialog is divided into 2 tabs. The **Table Fields** tab brings up the Table Settings panel shown below. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside the area.

The **Table Fields** tab contains two listboxes which are used to control which of the area fields will appear in any table rows that are generated for areas. You use the Add and Remove buttons to control which fields will be included in area tables. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area table will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

**Field Settings Dialog:** To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

**Column Title:** This will be the tile name used for the field's column in the area table.

**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard
color picker dialog. To use the default for the Text Layer, select ByLayer.

Prefix and Suffix: Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.

Justification: Use this to control whether the label field is left, centered or right justified.

+/-: This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

Precision: Choose precision level for the currently selected field.

Column Width/Auto: The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column with in text size units.

The Table Settings tab brings up the Table Settings panel shown above. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside the area.

Table Parameters:

Total Area on Last Row: Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

Label Layer: Use this to control the layer that the area table reference will be placed in. Use the Select button to pick from a list of all known layers.

Label Color: Use this to control the color of the area table reference. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

Area Label Prefix: Use this to control the prefix of the area table references. Add a space after the prefix to have the prefix and the reference number separated by a space if desired.

Label Text Style: Use this to set the text style of the area table reference. Use the Select button to pick from a list of all known text styles.

Table Layer: This allows the user to set the layer that the table will be placed in. Use the Select button to pick from a list of all known layers.

Table Color: This allow the user to set the color of the grid lines of the table. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

Area Table Title: To add a title row as the first row of the area table, enter a table title here.
Title Text Color: This allows the user to set the color of the table title. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

Title Text Style: Use this to set the text style of the table title. Use the Select button to pick from a list of all known text styles.

Title Text Size: Use this to control the size of the table title text.

Background Colors: The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective "Use Table...Background Color" box must be checked. This enables the Select button, which is used to pick the respective background color from a color picker dialog. For the Contents zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.

Pulldown Menu Location: Area/Layout->Area Tables
Keyboard Command: defatab
Prerequisite: None

### New Area Table

This command draws the column header labels for the Area Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. This table becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with the atabset command (menu item Area/Layout > Area Tables > Set Active Table).

| Area | Perimeter | Sq. Feet | Acres | Lot Description |

**Prompts**

Starting point of area table: *pick point*

Pulldown Menu Location: Area/Layout-> Area Tables> Create New Table
Keyboard Command: atabnew Prerequisite: None

### Set Active Area Table

This command allows the user to change the active area table. The table selected becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with another invocation of this command.

**Prompts**

Select active Table: *pick area table*

Pulldown Menu Location: Area/Layout-> Area Tables> Set Active Table
Keyboard Command: atabset Prerequisite: None

### Edit Area Table Properties

This command allows the user to edit the properties of an area table.

**Prompts**
Select an area table to modify: *pick an area table*

After picking an area table the Area Defaults dialog will be displayed. Here you can change the settings of the selected table. The changes will be reflected once the user selects the OK button.

The Table Fields tab contains the Available Fields and Used Fields listboxes which are used to control which of the possible ten area fields will be used in the area table. You use the Add and Remove buttons to control which fields will be included in the table. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

Field Settings Dialog: To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

Column Title: This will be the tile name used for the field's column in the area table.
Text Style: This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.
Text Size: This value is multiplied by the horizontal scale to obtain the actual text size.
Text Layer: This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.
Text Color: This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.
Prefix and Suffix: Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.
**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/-:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

**Column Width/Auto:** The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column width in text size units.

The **Table Settings** tab brings up the Table Settings panel shown below.

![Table Settings Panel](image)

**Total Area on Last Row:** Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

**Label Layer:** Use this to control the layer that the area table reference will be placed in. Use the **Select** button to pick from a list of all known layers.

**Label Color:** Use this to control the color of the area table reference. Use the **Select** button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

**Area Label Prefix:** Use this to control the prefix of the area table references. Add a space after the prefix to have the prefix and the reference number separated by a space if desired.

**Label Text Style:** Use this to set the text style of the area table reference. Use the **Select** button to pick from a list of all known text styles.

**Table Layer:** This allows the user to set the layer that the table will be placed in. Use the **Select** button to pick from a list of all known layers.

**Table Color:** This allows the user to set the color of the grid lines of the table. Use the **Select** button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Area Table Title:** To add a title row as the first row of the area table, enter a table title here.

**Title Text Color:** This allows the user to set the color of the table title. Use the **Select** button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Title Text Style:** Use this to set the text style of the table title. Use the **Select** button to pick from a list of all known text styles.

**Title Text Size:** Use this to control the size of the table title text.

**Background Colors:** The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective **"Use Table...Background Color"** box must be checked. This enables the **Select** button, which is used to pick the respective background color from a color picker dialog. For the Contents
zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.

**Load/Save:** These buttons save and recall all the Area Default settings to a .ARS settings file.

**Tip:** Keep in mind that changes made here only apply to the selected table. If properties are changed within the Configure command, the changes apply to all new work sessions as well.

**Pulldown Menu Location:** Area/Layout> Area Tables> Edit Properties

**Keyboard Command:** atabedit

**Prerequisite:** An area table

---

## Remove Area Table Rows

This command allows the user to remove rows from an area table. The routine will remove both the table row and the table reference label from the drawing.

### Prompts

**Select a table row to delete:** *pick area table row*

**Consolidate table [<Yes>/No]??** If consolidation is chosen, row numbers will be renumbered to close up the gap created by this deletion. Consolidation will also update all relevant area table references in the drawing. If the user chooses not to consolidate the table at this time, the atabfix command (menu item Area/Layout> Area Tables> Consolidate Table) can be used at any time to perform consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>629.20</td>
<td>15572.47</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>41540.60</td>
</tr>
</tbody>
</table>

The drawing above shows the table before row removal. In the drawing below, row 2 has been deleted without table consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

The drawing below shows the results of deleting the same row 2, only this time the user has chosen to perform table consolidation.
Pulldown Menu Location: Area/Layout> Area Tables> Remove Row  
Keyboard Command: atabel  
Prerequisite: None

Consolidate Area Table
This command allows the user to renumber area tables to eliminate numbering gaps left as the result of row deletions or other means.

Prompts

Select a table to consolidate:: \pick area table
Row numbers will be renumbered to close up the gaps in the selected area table. Consolidation will also update all relevant area table references in the drawing.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

The drawing above shows the table before row removal. The drawing below shows the results of consolidating this table.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Area/Layout> Area Tables> Consolidate Table  
Keyboard Command: atafix  
Prerequisite: None

Tag Area Descriptions
This command is used to assign a description to a closed polyline. The description is stored with the polyline in the drawing. This description is used for reports in routines like Area By Closed Polylines.

Prompts
Select polyline for area description: pick a polyline
Area description <AREA1>: West Pond

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: tag_area_desc
Prerequisite: A closed polyline.

Identify Area Descriptions
This command reports area descriptions for the selected polylines. There are two methods. The Pick method reports
the area description for one selected polyline at a time. The Search method scans the whole drawing and highlights
polylines with area descriptions.

Prompts

Pick polylines to check or search drawing [Pick/Search]: press Enter
Select area description polyline: pick a polyline
Description: West Pond
Select area description polyline (Enter to end): press Enter

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: id_area_desc
Prerequisite: A polyline with a tagged area description.

Untag Area Descriptions
This command removes an area description that has been assigned to a polyline.

Prompts

Select polylines to remove area description from.
Select entities: pick area polylines
Cleared 10 area descriptions.

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: untag_area_desc
Prerequisite: A polyline with a tagged description.

Hinged Area
This command can be used to determine the dimensions of a figure when the area is fixed and three or more sides are
known. The figure can be defined by a closed polyline or by picking the known points and curves. The command
then prompts for the area to be solved for (in square units and acres).

Prompts

Define area by points or closed polyline [Points/Linework]? press Enter
Select polyline segment to adjust: select a polyline segment
Select hinge point [endp]: Move the cursor around to find a hinge point.
Keep existing polyline [Yes/No]? N
Polyline method

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** harea  
**Prerequisite:** A closed polyline or at least one known side. Two direction lines should be drawn.

### Sliding Side Area

This command adjusts one side of a polyline to meet a specified area. The existing area can be defined by a closed polyline or by picking each point in the perimeter. The desired area can be entered in either square feet or acres. The area to adjust must be represented by a closed polyline. The program moves the selected segment of the polyline in or out. There a few methods for defining the direction of the adjusted segment. With the Selected method, the original direction of the segment is maintained. The Line method prompts to pick another line segment to define the direction. The Angle method uses an entered angle for the direction. The Points method prompts for two points to define the direction.

### Prompts

- **Define area by points or closed polyline [Points/<Linework>]? press Enter**
- **Select polyline segment to adjust:** pick a point on a closed polyline  
- **Keep existing polyline [Yes/<No>]? press Enter**  
- **Define new line by selected line, another line, angle or points [<Selected>/Line/Angle/Points]? press Enter**

Area: 176044.14 S.F, 4.0414 Acres  
Remainder/Acres/<Enter target area (s.f.)>: 17800
Linework Polyline method:
Original perimeter polyline on left, adjusted perimeter on right

Points method

Pulldown Menu Location: Area/Layout
Keyboard Command: ssarea
Prerequisite: A closed perimeter polyline

**Area Radial from Curve**
This command swings a line radial from a curve to reach a predetermined area. The existing area can be defined by polylines or by picking each point on the perimeter. For the point method, the curve to radiate from should be the last entity selected when defining the figure. For the polyline method, front and back polylines are used. The computed line goes perpendicular from the front polyline and intersects the back polyline. This line is moved to find the target area. Both ends of the front and back polylines are connected to close the area. The options for the polyline method are set in the dialog shown.

**Prompts**

Define area by points or closed polyline [Points/<Linework>]? press Enter
Area Radial from Curve dialog Make choices and click OK.
Select curve to radiate from: pick the curve
Select back polyline: pick the back polyline
Lot Area: 9000.00 S.F., 0.2066 Acres
**Point Method**

**Polyline Method**

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** arearc

*Chapter 3. Survey Module* 639
**Prerequisite:** An existing area defined by points or polylines

---

**Bearing Area Cutoff**

This feature allows you to cut a predetermined area from a closed figure using a cut-off line having a specified bearing. The boundary intersected by the cut-off bearing line can be either a straight line or arc.

**Enter area in ACRES [Sq. Feet/Done] <0.000000>:** Enter the number of acres contained within the cut-off area.

To change from acres to square feet, type S and <Enter>.

**Note:** if units are set to meters, the prompt will be:

**Enter area in HECTORS [Square meters/Done].**

**Enter bearing of cutoff line <100.000000>:** Enter the bearing of the cut-off line through the property using Qdd.mmsss format.

<table>
<thead>
<tr>
<th>Q</th>
<th>Quadrant</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NE</td>
</tr>
<tr>
<td>2</td>
<td>SE</td>
</tr>
<tr>
<td>3</td>
<td>SW</td>
</tr>
<tr>
<td>4</td>
<td>NW</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>d</th>
<th>Degrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>m</th>
<th>Minutes</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>s</th>
<th>Seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

**Note:** Trailing zeros need not be entered.

**Place area to right or left of bearing line [Right/Left] <R>:**

"Looking" in the direction of the cut-off bearing allows you to determine which side is left or right. Type R and <Enter> or just <Enter> for right. Type L and <Enter> for left.

**Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>:**

Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

**Defining the overall area using a C&G Point Group:**

If you have a C&G Point Group that defines the area to be divided and you choose to use the point group option, you will then be asked to use a file dialog to browse to the point group file and select it.

**Defining the overall area manually:**

If you choose to type or pick the points defining the overall area individually, you will see the prompt:

**Enter point ID or pick graphically [cLockwise/ccW/Polyline]:** Specify a point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

**Note:** if you choose to pick a polyline, it must be a closed polyline and all its vertices must have coordinates matching points found in the coordinate file.

When specifying individual points, move around the parcel and pick or type in the points, in order, to define the overall area involved.

After all points have been entered, press Enter to end point input.

**Calculate the Cut-off Line**
No matter which method you use to specify the property being divided, once the overall tract is specified, the cut-off line is calculated and the points at which the cut-off line intersects the tract boundaries are saved.

The **Saving Point** dialog (below) will be shown for each intersection point.

![Saving Point dialog](image)

Click the **OK** button to save the intersection point.

Depending on your settings for **Auto Line Plot** and **Auto Point Plot** on the **Graphics** tab of the **C&G Options** dialog box, you may see both the points and the cut-off line drawn on the screen.

This process can be repeated as many times as is necessary to further divide the overall area or to divide another area. Press `<Esc>` or "D" at the **Enter area...** prompt to end the command.

**Prompts**

**Enter area in ACRES [Sq. Feet/Done] <0.000000>:** Enter the number of acres contained within the cutoff area or type "S" and Enter to use square feet or "D" and Enter when done.

**Enter bearing of cutoff line <100.000000>:** Enter the bearing of the cut-off line through the property.

**Place area to right or left of bearing line [Right/Left] <R>:** Type "R" and Enter or just Enter for right of line. Type "L" and Enter for left. The direction of the cut-off bearing determines which side is left or right.

**Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>:** Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.
for Manual entry:

**Enter point ID or pick graphically [cl]ockwise/ccW/Polyline:** Specify the point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

Pulldown Menu Location: Area/Layout
Keyboard Command: baco
Prerequisite: Coordinate file.

Lot Layout

This command draws lots based on a front and back polyline. Starting from the front polyline, the program calculates two lot side lines perpendicular from the front polyline that intersect the back polyline and create the specified lot size. Lots are created along the front polyline in the order that the front polyline is drawn. If the front polyline needs to be reversed, use the *Reverse Polyline* command found on the Edit menu. The direction of the back polyline does not matter. The lots can be drawn as closed polylines or just the lot sides can be drawn. There is also an option to automatically create all the possible lots at the specified area between the front and back polylines or to prompt for each 0.4 acre lot.

In prompt mode, the program reports the remaining area between the front and back polylines and then asks for the lot size. The lot size can be specified either by area or frontage along the front polyline.

The lots are sized to meet the specified area and also meet the minimum frontage and backlot distances. The program starts by checking the lot area at the minimum distances. If this area is greater than the target, then the lot is drawn at the minimum distance and the resulting lot area will be greater than the target area. Otherwise the program will increase the frontage until the lot reaches the exact target area. The *Use Frontage Setback Polyline* option allows you to use another polyline besides the actual frontage polyline for the minimum frontage indicator. Typically, this Frontage Setback Polyline would be offset a set amount from the actual frontage polyline.

Prompts

Lot Layout dialog

Select front polyline: *pick a polyline*
Select back polyline: *pick a polyline*
With prompt for each lot active:
Area remaining: 160326.88 S.F, 3.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.2269>: l
Area remaining: 116766.88 S.F, 2.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: F
Enter Frontage <50.00>: 75
Lot Area: 37807.50 S.F., 0.8679 Acres
Area remaining: 78959.38 S.F, 1.8127 Acres
Quit/Area/Enter frontage <50.00>: A
Quit/Frontage/Enter lot area (Acres) <1.0000>: press Enter
Area remaining: 35399.38 S.F., 0.8127 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: Q

Polylines for Lot Layout
The Front Polyline goes from right to left

Resulting lots numbered using Sequential Numbers

Pulldown Menu Location: Area/Layout
Keyboard Command: lotlay
Prerequisite: A frontage polyline and a backlot polyline.

Offsets & Intersections
This command takes a set of centerline polylines and calculates the series of offset polylines using the user defined offset and fillet radius values. The function recognizes primary and secondary roadways which allows for different offsets and fillet radii to be specified for each. Up to seven sets of offsets and radii can be defined for different features such as edge of pavement, right-of-way, sidewalk, etc. Each set also has a layer name and description. The Pick button lets you set the layer name by picking an entity with that layer in the drawing. The description is for your own information and is not used by the program.

Multiple centerline polylines can be processed together which allows for the creation of an entire set of roadway offset polylines in one step. Intersections are calculated based on the centerlines selected and the fillet radii are applied at the intersections. The Smooth Interior and Exterior Corner options will fillet bends in the offset polylines. Otherwise turns without an arc in the original centerline will become straight corners in the offset polylines. The
results of the calculations for the given parameters may be previewed in the dialog. Zoom and pan are available by clicking and dragging mouse on the preview image (zoom or pan mode is selected by a toggle). Once the satisfactory offsets are calculated, they are inserted into the drawing by clicking on Finish2D button. The Finish 3D button opens the *Elevate 2D Polylines* command, described in this chapter.

If it is preferable to handle intersections manually, you may run the command multiple times on non-intersecting centerlines. Another alternative is to use the *Offset* command in the Draw menu and the *Fillet* command in the Edit menu.

![Offsets and Intersections dialog](image)

### Prompts

**Select all PRIMARY road polylines.**

Select objects: *select polylines*

Select objects: *Enter*

Select all SECONDARY road polylines.

Select objects: *select polylines*

Select objects: *Enter*

Calculating offsets for layer EOP...

Calculating offsets for layer ROW...

Pulldown Menu Location: Area/Layout

Keyboard Command: *wayint*

Prerequisite: Centerline polylines

### Cul-de-Sacs

This command uses a polyline centerline and the offset polylines to create a cul-de-sac. These offset polylines can be generated by the *Offsets & Intersections* command, or with the standard *Offset* command. The layer names of the offset polylines must match the layer names set in the dialog.

To run this command, pick a set of polylines and point on roadway centerline where the cul-de-sac center is. For
cul-de-sacs with an offset center, pick a projection of that center onto the centerline and specify an offset distance (positive value is offset to the right, negative - to the left). Like the Offsets and Intersections command, a preview is shown of the cul-de-sac being designed. Any of the cul-de-sac parameters may be modified and reviewed before the cul-de-sac is applied and the drawing is modified with the Finish 2D button. The Finish 3D button opens the Elevate 2D Polylines command described in this chapter.

Bend cul-de-sacs are created by selecting offset entities on one side of the centerline.

![Design Cul-de-Sac](image)

**Prompts**

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *make selections*

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** stdcul

**Prerequisite:** A set of offset polylines and roadway centerlines.

**Elevate 2D Polylines**

This command allows to assign elevations to a selection of polylines based on elevations along supplied 3d centerline and user-defined slopes. This routine calculates a distance from each vertex of 2D polyline to a specified 3D reference polyline and uses that distance and slope to calculate a 3D offset to a corresponding point on 3D polyline.

You can specify either the original centerline to be a reference 3D polyline or use another set of offset polylines. For example, you could specify the edge of pavement elevation to be relative to the curb elevation, while curb elevation is calculated based on the centerline elevation. You can view the resulting road/intersection design in 3D, making changes and updating picture on-the-fly. Local sink points can be reported instantly by evaluating a resulting triangulation to predict low points in the design leading to water retention.
Prompts

Select all offset polylines for the intersection.
Select objects: select entities
Select all 3D profile polylines.
Select objects: select entities
Pulldown Menu Location: Area/Layout
Keyboard Command: 3dintersect
Prerequisite: A set of offset polylines and roadway centerlines
Parking
This command draws a series of parking stalls. The command prompts for stall width and length, stall parking angle, and side for stalls. Stalls can be located by the number of stalls in a direction, as many as fit between two points, or along a polyline.

**Parking Settings**

- **Stall Layout Method:** Indicate the method of stall creation whether it be a desired number of stalls or as many stalls as can be fit on an alignment.
- **Min Stall Width:** Indicate the minimum width a stall can be when the Fit on Alignment option is specified.
- **Max Stall Width:** Indicate the maximum width a stall can be when the Fit on Alignment option is specified.
- **Stall Width:** Indicate the stall width when the Number of Stalls option is specified.
- **Number of Stalls:** Indicate the desired number of stalls when the Number of Stalls option is specified.
- **Stall Length:** Indicate the desired length of each stall.
- **Side for Stalls:** Indicate the side to which the stall lines should be placed.
- **Stall Placement Method:** Indicate the method by which the stall direction should be determined whether it be between two picked points or along an existing graphical alignment.
- **Layer:** Specify the layer on which parking lines should be placed or click the Set button to choose an existing layer.

**Prompts**

**Starting Point?**
**Pick point or point number:** Pick a point

**Ending Point?**
**Pick point or point number:** Pick a point

Created 10 stalls.

**Pulldown Menu Location(s):** Civil → Area/Layout → Layout Utilities, Survey → Area/Layout → Layout Utilities

**Keyboard Command:** parking

**Prerequisite:** None.
Set Back Measure-Move

This command can be used to measure the perpendicular distance of 1 or 2 points to 1 or 2 lines. This can be helpful in placing buildings for proper setback from lot lines. After selecting the lot lines and the building, the command allows you to drag the building while a real time display on the side-bar menu shows the perpendicular distances to the lot lines. After experimenting you can press T to type in the values to move to. The second line and point are optional.

Prompts

Select 1st Lot line to measure perpendicular from.
Select object: select line
Select 2nd Lot line to measure perpendicular from ([Enter] for none).
Select object: select line
Select entity to move at 1st point to measure from:
Select object: ENDPOINT of (Pick a point on polyline.)
Pick a 2nd point on entity to measure from ([Enter] for none). END of (Pick a point.) Pick another endpoint of the polyline representing the building.
Drag-Pick new Location or [T]ype in Move distance(s) [C] to Cancel: T Either drag the building to a location and press the pick button on your pointing device or press T to enter the distances.
You may have to use a negative distance to move to the proper side of lot line!
Distance from 1st line: 10
Distance from 2nd line: 20
The building is then moved to your specification.

Pull-down Menu Location: Area/Layout
Keyboard Command: setback
Prerequisite: Lot lines and polyline representing the building should be plotted.

Draw Lot Setback

This command draws closed polylines inside lots to represent the building setback offsets. Before running this command, the lots need to be draw as closed polylines. The command starts with a dialog for entering the setback offsets and the layer for the new setback polylines. The Front to CL Max Offset is used to determine which lot edges are frontage. The program will prompt to select CL reference polylines and lot edges that are within this offset from these CL polylines are considered frontage edges. The Front Setback is applied to the lot frontage edges. The Side Setback offset is applied to lot edges that have only one of their ends within the frontage offset. The Back Setback offset is applied to all other lot edges.
**Prompts**

**Lot Setback Polylines dialog**
Select reference centerline polylines.
Select objects: **pick the polylines**
Select lot polylines to setback.
Select objects: **pick the polylines**

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lot_setback  
**Prerequisite:** Lot and CL polylines

**Fit Structure**

The purpose of the Fit Structure feature is to place a structure (or the footprint) within a bounding polygon. For example, a house foundation - the footprint - within the limits of the setback lines of a lot - the bounding polygon.

The user can easily insert a structure footprint within a lot or bounding polygon near its final location. The footprint then it can then be conveniently rotated and/or translated, in user definable increments, to the exact position desired.

**Footprint Templates**

The template, a full scale definition of a structure’s footprint, must be defined prior to placing it within the bounding polygon.

Templates are not AutoCAD drawings but they can be imported from AutoCAD drawings.

The data specifying the dimensions of a template is stored in a binary format and cannot be manipulated without using the Template Manager. Once a template is placed in the drawing, it becomes a C&G footprint polyline. Since
it is a C&G polyline, it can be queried and manipulated using ordinary AutoCAD and CGSurvey commands.

Template Manager

The Template Manager is used to manage the templates for the various projects you work on. For example, the various house footprints used in a given subdivision can be defined as templates. The templates can then be placed in a lot in an "as" or "reverse" orientation and reused as many times as necessary. You can use the Template Manager to define templates directly or import the templates from existing AutoCAD drawings.

The Template Manager allows you to organize your templates within projects. You can name the projects in a meaningful way then import the templates into the project "folder".

When you choose the Fit Structure feature from the Cogo menu for the first time, a dialog warns you that you have no templates defined then brings up the Template Manager.

In the dialog below you will notice that there is nothing listed under the Projects item. This means that you will have to either create a template or import one from an existing drawing.

Creating a Template:

To create a new template, click the Create button. This brings up a dialog that allows you to configure the simple drawing in which you will create a template. This dialog allows you to specify the name of the project, the name of the template and asks about the approximate overall size of the template. If the structure template is made up of right angle segments you may want to specify a snap grid to aid you in laying out the template. You should be
aware that the create template method should only be used for very simple templates and that it does not allow you to edit the structure once it is added to the Template Manager.

When you are done configuring the create template drawing interface, click OK and you will be see an empty AutoCAD screen upon which you can draw the template. The template is merely a closed polyline. The C&G Polyline by Points interface is used but in this case there will only be normal AutoCAD points picked (also known as graphic points designated as GR-PT). The polyline must be closed - so use the C for Close command line option for the last line segment in the template. Once you enter the Close option keyword for the polyline you are working on, the drawing window closes and the template is imported into the Template manager as shown below.
Note: You must click on the template name in order to see its shape in the window on the right and to choose it as the current template.

Importing a Template
The Create template method is only useful for very simple templates. For more complicated templates and projects with multiple structures, it is recommended that you use the Import method. To import a template you must create a separate drawing, then draw all of your templates at full scale on the layer specified for templates (see Fit Structure Setup).

Create a separate template drawing
Begin the importing of a template by creating a new drawing file as a repository for all the structure template drawings used in a specific project. For this example we will create a new drawing named Mitchell Estates bldgs.dwg. This file will only contain the structure template drawings for this project.
Select the CAD File menu then select the menu New item
You may be asked to choose a drawing template (not to be confused with the structural template polylines you are about to create). It is generally easiest to use the default acad.dwt drawing template but you may also specify one of your own choosing.

In this new drawing create a layer having the name specified in Fit Structure Settings and make this layer current. You can accomplish this by using the CAD Layer Manager. To open the Layer Manager, from the Format menu choose the Layer menu item.

In the new drawing, draw the templates (house footprints for example) you will be using in your project. A structure template must be a closed polyline and may contain arc segments.

Draw the individual house footprints. It is recommended that you use either the C&G Polyline by Points feature or use the standard CAD PLINE command - on the Draw menu choose 2D Polyline.
You could also use the C&G Quick Traverse feature to traverse around the building. However, if you use Quick Traverse to create the footprint you must then convert the C&G lines created by Quick Traverse to polyline. To do this you can use a utility on the CGTools menu, Join Nearest.

Once you have created the templates needed, close and save the template drawing file. You can come back to this drawing at anytime and add or modify templates as needed.

**Note:** If you change a template in the original template drawing, you must be re-imported using the Template Manager. First, use the Template Manager’s Delete feature to delete the old template, then re-import the changed template from your template drawing file.

### Placing a Footprint:

Return to the original drawing into which you wish to insert the footprint. In this example Mitchell Estates.dwg will be used to place structure footprints within lot setbacks.

Select the Fit Structure menu item.

If this is the first time you have run the command and no templates have been specified, you will be informed of this by a warning dialog. Click OK in the warning dialog and the Template Manager will come up.

If you have inserted a template prior to running this command, the following prompt will be seen at the command line:

**Choose a structure template**

[Set template/Current-template (Wilson)/Mirror-current/Done] <C>:

Select "S" for Set template to bring up the Template Manager.

### The Template Manager

As mentioned earlier, the Template Manager is used to manage the structure templates you use for your various projects. In the left hand pane the projects and their associated templates are arranged similar to the directories in the Windows Explorer. On the right pane is a drawing showing an unscaled representation of the shape of the currently highlighted template. The highlighted template becomes the current template when you Close the Template Manager. The following describes the Template Manager functions in more detail.

**Delete button:** This allows you to delete a Project or an individual template. **Create button:** This allows you to generate a template "on-the-fly" while in the current drawing file. This method of creating templates should only be used for the simplest of templates. In most cases it is recommended that you import pre-drawn templates from other existing drawings.

When the Create button is selected, the Add A Template dialog appears (shown earlier).

**Name of Project:** enter a new name or press the down arrow to select from existing projects.

**Name of Template to Add:** enter a new name or press the down arrow to select from existing projects.

**Approximate Overall Dimensions of Template:** enter an approximate length and width. Make sure this overall dimension will include the entire template so you will be given enough room to draw the template - too large is better than too small.
Grid:
If you wish to have a snap grid as a drawing aid when you create a template, check the Use grid to aid in drawing the template checkbox and set the grid interval. You need not use a grid but it is useful in creating simple rectangular templates.

Click OK to begin creating the template. To create the template, pick the desired locations for the various building corners. Be sure to close the structure perimeter by typing C and Enter. After closing the template polyline you will be returned to the Template Manager.

Import button:
clicking this button allows you to import the template from another drawing file. As described earlier, you should create a separate template drawing. In that drawing draw the required templates as closed polylines. The templates may contain arcs.

When you select the Import button a dialog (shown earlier) comes up asking you to enter or select a Project Name and to specify the Name of Template to Add.

The Project Name can be anything you wish but is often the name of the subdivision or the client name. The template name can also be anything you wish. It should generally reflect the type or style of structure the template represents.

After filling out the project and template names and clicking OK, a file dialog will be displayed. Choose the drawing file you created earlier containing the template(s) you wish to import.

After closing the file dialog the template drawing will be shown and you will be asked to choose the template polyline. When you pick the template polyline its geometry is stored in a special file reserved for template information and you will be returned to the Template Manager.

If you highlight the newly imported template on the left hand pane it becomes the current template and you should see it displayed in the right hand pane.
If you wish to import another template just repeat these steps as many times as necessary.

By highlighting the template name it is made the current template. You may choose to mirror the current template on the Y axis by checking the Mirrored checkbox. All you need do now is click the Close button to close the Template Manager and place the footprint in the drawing.

**Fit Structure Example**

The following file names will be used when describing the following example:

- Coordinate File: Mitchell Estates.crd
- Drawing File: Mitchell Estates.dwg
- Template Drawing File: Mitchell Estates bldg.dwg

**Note**: The template drawing file may have several templates in the same drawing file. For example you may have a subdivision with many different house footprints.

**Import the templates**

Open the subdivision drawing file, in this case; Mitchell Estates.dwg, and the associated coordinate file: Mitchell Estates.crd.

The subdivision drawing should already exist and you should have already defined the bounding polygons within which the structures are to be placed. These bounding polygons can be defined either by polylines (arcs are allowed) or lines and arcs. The lots and setbacks (bounding polygons) can also be defined using a C&G Point Group or Groups.

Once the subdivision drawing is open and has been prepared for the placement of structures choose **Fit Structure** from the menu.

If you have not run the **Fit Structure** command and set a current template in this drawing session, the Template Manager dialog will appear.
The first task will be to create a project and import templates from the template drawing file, Mitchell Estates bldg.dwg.
Select the Import button and fill in the project name and template name.
In this example the subdivision name is Mitchell Estates and the house model being added to the template list is the Wilson.
Next a drawing file dialog will be displayed. Highlight the template drawing file (in this case Mitchell Estates bldg.dwg) and click the Open button and use the cursor to choose the polyline representing the template to be imported.

After choosing the template polyline, you will be returned to the Template Manager. You will notice that the template you just chose has been added to the template manager under the project you selected. To see its shape and make it the current template, click the template name under the current project.
You may continue to add templates as required. Click Close to begin placing the template in the subdivision drawing.

After the Template Manager closes you will return to the main drawing and see the following prompt:

**Pick the lot within which the structure will be placed [cg-Point-group/Done] <pick>:**

Pick a polygon or a series of lines that define a closed lot boundary or setback within which you wish to place the structure. Type P and Enter to use a C&G point group file to define the bounding polygon.

**Place the structure in the bounding polygon**

Once you have specified the bounding polygon you will be asked to place the structure near its final location in the bounding polygon. Move the structure near its desired location using the mouse and click the left mouse button to place it at that location. Once you have picked the approximate location for the structure you will then be allowed to rotate and move the structure to its exact final location.

![Diagram of subdivision layout](image)

**Note:** If you need to adjust a template further once it has been placed within the bounding polygon and you have exited the Fit Structure command, you can run the Fit Structure command again and pick the existing structure instead of using a template.

**Adjust the structure**

After placing the structure in the bounding polygon you will see the following prompt at the command line:

**Adjust structure [Move/Step-move/step-Rotate/rotTate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>:**
You are now at the stage where the structure can be adjusted to its final desired location with relationship to the setback lines and its orientation with respect to the street and other features.

In all the commands used to adjust the structure, the distances to the bounding polygon may be displayed at the appropriate corners of the template (see example below). You may turn this distance display on or off or view or change other fit structure parameters using the setUp option (type U and Enter at various the prompts).

**Move:**
Type M and Enter to "drag" the structure around using the mouse cursor - similar to when you first placed the structure in the bounding polygon. This option is only meant for moving the structure in a gross, imprecise way and thus allow you to place it near its final location. After using this option the structure can be more finely adjusted using one of the other options described here.

**Step-move:**
To move the structure up, down, left or right, using the arrow keys on the keyboard, type S and Enter. The following prompt will appear:

**Press arrow keys to move 1.000 dwg units [setUp/Done] <D>:**

Now you can use the arrow keys on your keyboard to move the structure by steps in the X and Y directions. The distance moved per keystroke is indicated at the command line - in this case the structure moves 1 unit each time you press an arrow key. To change the per step increment, type U for setUp. This brings up the Fit Structure Setup dialog, allowing you to change the Translation Step setting (see below).
Click **OK** to return to the **Adjust Structure** command line.

**Step-Rotate:**
If you type R and Enter for step-Rotate you can then use the up and down arrow keys on the keyboard to rotate the structure by small rotational steps.
The following prompt will appear:
**Use down/up arrow keys to rotate 10°00'00" clockwise/ccw [setUp/Done] <D>**:

**Rotate:**
To rotate the structure, type R and Enter. The following prompt will appear:

**Rotate structure to desired orientation: [setUp] <pick>**:

Use this option to rotate the structure by moving the mouse. Left clicking will place the structure at the current rotated orientation. This method of rotation is not precise and is thus useful only for gross rotational movements.

**rot-Ninty:** Type N and Enter to rotate the structure 90 degrees in a clockwise direction.

**Parallel:**
Type P and Enter to rotate the structure so that one of its sides is parallel to a specified line segment on the bounding polygon.
First, select the side of the bounding polygon that you wish to be parallel to a selected side of the structure.
Next, select the side of the structure that is to be parallel to the previously selected line on the bounding polygon.
After picking the side on the structure the structure will be rotated into position.

**Note:** If the rotating the structure about its geometric center to make the selected sides parallel to one another will cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the **Adjust Structure** ... prompt.

**On-boundary:**
Type O and Enter to choose a point on the structure that is to touch a selected point on the bounding polygon. This is accomplished by translation only.
Pick the point on the bounding polygon where you want the structure to touch: Pick the point where the structure touches the bounding polygon.

Choose the point on the structure that you want to touch the bounding polygon: Pick the point on the structure that touches the bounding polygon.

If choosing a structure corner as the point to touch the bounding polygon, you should use the end point snap. If you do not use end point snap, the translation of the point picked to the bounding polygon will likely cause the corner of the structure to encroach. You can specify end point snap when picking the point on the structure by typing in "end" and Enter at the prompt, then you merely need to pick a point on the structure near the desired corner to actually specify the corner point.

Note: If the translating the structure to make the selected point touch the bounding polygon at the selected point would cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the Adjust Structure ... prompt.

Completing the adjustment process

Once you are satisfied with the location of the structure type D and Enter and you will see the following prompt:

Creating structure coordinate points:
Enter description for structure corner points <footprint.pt>:

You can accept the default description shown in brackets by pressing Enter or you may type in a description that will help you identify this particular structure and lot. The corner and any radius points for the current location of the structure are stored in the current coordinate file and, if Auto plot points is ON, the points are drawn. After storing the points for the previously placed structure you will see the following prompt:

Choose a structure template [Set template/Current Template/Mirror current/Done] <C>:

Press Enter or C and Enter if you wish to repeat the process and place the current structure template in the same or another bounding polygon. If you wish to place a mirrored ("reverse") version of the current structure template in a bounding polygon, type M and Enter. If you wish to place a different structure in a bounding polygon, type S and Enter to bring up the Template Manager, allowing you to pick a new template. If you are done placing templates for now, type D and Enter for Done. At any time you may adjust an existing structure by choosing Fit Structure. If there are existing structures in the drawing, it will be detected and the following the prompt will appear at the command line:

Pick existing structure to adjust or choose a structure template.
[Set-template/Current-template(Wilson)/Mirror-current/Done] <C>:

At this prompt you can use the mouse to pick an existing structure to adjust. You can now use any of the adjustment methods described above to further refine the location of the structure. After the adjustment process is complete the coordinate file is updated to reflect the adjusted locations of the structure's corner and radius points.

Note: When you pick an existing structure, any plotted corner point symbols are temporarily removed to facilitate the adjustment process. Once you are done adjusting the existing structure, these points are re-plotted at their new adjusted locations.

At this prompt you may also choose to place a new structure in a bounding polygon. To use a different template, type S and Enter to bring up the Template Manager and allow to choose the desired template. If you
have already placed a template in the current drawing session, the prompt will indicate the current template. By typing C and Enter or just pressing Enter you can choose to place the current template in a bounding polygon or you can type M and Enter to place a mirrored version of the current template:

**Prompts**

**Template Manager dialog:** create or choose a template to place within a bounding polygon (a lot)

**Add a Template dialog:** Used in conjunction with the Template Manager dialog to add a template to a given project.

if you have already specified a template to use but no templates have been placed in the drawing:

**Choose a structure template**

[Set template/Current template (Wilson)/Mirror-current/Done] <C>: Type ”S” and Enter to bring up the Template Manager dialog. Type ”C” and Enter or just Enter to use the current template. Type ”M” and Enter to mirror the current template. Type ”D” and Enter when done placing templates.

if a structure/template exists in the drawing or you have already specified a template to use:

**Pick existing structure to adjust or choose a structure template.**

[Set-Template/Done] <S>: To adjust an existing structure pick it on the screen. Type ”S” and Enter or just Enter to bring up the Template Manager dialog to choose a new template. Type ”D” and Enter when done.

after you set a new template or chose to use the current one:

**Pick the lot within which the structure will be placed** [c&g-Point-group/Done] <pick>: pick the polyline or a series of lines that define a closed polygon within which the structure template will be placed. Type P and Enter to specify the bounding polygon using a C&G Point Group file.

**Place the structure near its final location in the bounding polygon** <pick>: Drag the structure template to the desired location and click the left mouse button to place the structure.

after you place a template or pick one to adjust:

**Adjust structure** [Move/Step-move/step-Rotate/roTate/rot-Ninty/Parallel/On-boundary/setUp/Done] <D>: Type ”M” and enter to move the structure. Type ”S” and Enter to use the arrow keys to move the structure in predefined steps. Type ”T” and Enter to use the cursor to rotate the structure. Type ”R” and Enter to rotate the structure template a predefined number of degrees using the up and down arrow keys. Type ”N” and Enter to rotate the structure 90 degrees clockwise. Type ”P” and Enter to translate and rotate the structure template parallel to a side of the bounding polygon. Type ”O” and Enter to move the structure template so a chosen point on the structure touches a chosen point on the bounding polygon. Type ”U” and enter to use the Setup dialog to change the step sizes, layer names and other configuration items for the fit structure command.

when saving the structure coordinate points:

**Enter description for structure corner points** <footprint.pt>: Specify a description for the structure template corner points to be saved in the coordinate file or just press Enter to use the default description.

**Pulldown Menu Location:** Area/Layout > Layout Utilities

**Keyboard Command:** cg_fit_structure

**Prerequisite:** coordinate file, pre-drawn bounding polygon (lines and arcs or a polyline)

**Lot Network Settings**

This command displays a dialog for the current Lot Network Settings which specifies the lot network name, road network name, label settings, setback settings, hatch settings, building placement settings, lot type settings and lot area tolerance.
Lot Network: Click Select for the Lot Network name and choose the Lot Network file (.ltn).

Road Network: Click Select for the Road Network name and choose the Road Network file (.rdn).

Starting Lot Name: Indicate the starting Lot Name. As Lots are created, the trailing digit will be incremented by a value of 1.

Lot Area Tolerance: When creating lots to a target area, the program will finish adjustments when the area is within this tolerance of the target.

Automatic Label Updates: Enable this option if Lot labels should automatically update themselves if a Lot is altered or adjusted.

Edge Direction: Select an option to have new Lot lines drawn either Away From Frontage or Toward Frontage.

Default Lot Type: Settings in this section of the dialog box will be applied to all new Lots created using the "Default" Lot type.

Lot Line Layer: Specify a new layer or click Select to choose an existing layer for newly created Lot lines.

Label Lines and Arcs: Enable this option if you want this routine to label the newly created lines and arcs at the time new Lots are generated. For Line/Curve Label Settings, you can click Select to specify the Auto Annotate settings file (.aan) or click Edit to make changes to the Auto Annotate settings. For General Label Settings, you can click Select to specify the Annotation General Settings file (.adf) or click Edit to make changes to the Annotate Defaults settings.

Label Areas: Enable this option if you want this routine to label the areas at the time new Lots are generated. For Area Label Settings, you can click Select to specify the Area Defaults file (.ars) or click Edit to make changes to the Area Defaults settings. For Area Table Settings, you can click Select to specify the Area Table Settings file (.atb) or click Edit to make changes to the Area Table Defaults settings.

Draw Setbacks: Enable this option if you want this routine to draw Setback lines at the time new Lots are generated. Click Settings to adjust the Setback Settings as desired.
**Draw Hatch:** Enable this option if you want this routine to draw a Hatch pattern inside Lots at the time new Lots are generated. Click Settings to adjust the Hatch Settings as desired.

**Building Placement Settings:** Click the Building Placement Settings button to specify the values that should be followed when building pads are placed using the Lot Network routines.

**Lot Setback Parameters:** Adjust the front, side and back Setbacks as desired.

**Draw Building Pads:** Enable this option to draw building pad polylines.
**Building Polyline Layer:** Specify the layer on which building pad polylines should be drawn or click the Select button to choose an existing layer.

**Draw Building Symbols:** Enable this option to draw building symbols (blocks).

**Building Symbol Layer:** Specify the layer on which building pad symbols should be placed or click the Select button to choose an existing layer.

**Symbol:** Click the Select button to specify the name of the building symbol.

**Building Pad Width:** Specify the width of the building pad polyline.

**Building Pad Depth:** Specify the depth of the building pad polyline.

**Building Pad Setback:** Specify the distance behind the Setback line at which to place building pad polylines. Enter "0" to have building pad polylines placed directly on the Setback.

**Additional Building Pads:** Click the Add button to create additional building pads, the **Edit** button to modify existing building pads and the **Remove** button to delete building pads.

**Note:**

- When building pad creation is enabled, the initial Building Pad dimension will be attempted. If the initial building pad cannot be placed due to Lot size/placement restrictions, subsequent building pads in the Additional Building Pad list will be attempted.

LotNet sample showing setbacks and examples of varying building sizes.
LotNet sample showing 3D building symbol.

**Additional Lot Types:** Settings established in this section of the dialog box allow you to create additional types of Lots in order to apply different Line/Curve, Area, Area Table, Setback, Hatch and Building Placement Settings according to their specified Lot Type. Additionally, running a Lot Network Report will break out Lot data based on Lot Type and Lot Network Inspector will display Lot Type.

**Add, Edit and Remove:** Use these buttons to create additional Lot types, edit or remove existing Lot types.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet.config

**Prerequisite:** None.
Lot Network Boundary

These are a collection of commands to assign and verify the site boundary for lot network.

Set Boundary: Sets the site boundary. It must be a closed polyline.

Highlight Boundary Perimeter: Indicates the boundary to the user by highlighting it.

Hatch Boundary Perimeter: Indicates the boundary to the user by hatching it.

Erase Hatch Boundary: Erases the hatched boundary for the user.

Clear Boundary: Deletes the boundary designation from the polyline.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_limit, lotnet_highlight_limit, lotnet_hatch_limit, lotnet_hatch_erase, lotnet_unTag_limit
Prerequisite: None

Tag Sub-Area

This command provides the ability to establish "exclusion" areas (such as wetlands or drainage ponds) that limit where Lots or Lot Setbacks from the Lot Network routines can be created.

Prompts

Select polyline for sub-area: Pick a closed polyline that defines the sub-area.
Area Category: Provide the name of a general category for the sub-area.
Area Description: Provide a more specialized description for the sub-area.

Note:

- If a Sub-Area is created after a Lot Network has been processed, the existing Lot lines are kept and any associated setback lines are updated to honor the Sub-Area.
- If a Lot Network is processed after a Sub-Area has been created, the newly created Lots will honor the Sub-Area(s).

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: tag_subarea
Prerequisite: A closed polyline.

Untag Sub-Area

This command removes the from the selected polyline(s) the Sub-Area Category and Description information placed with the Tag Sub-Area command.

Prompts

Select sub-area polylines to remove sub-area tag.
Select objects: Pick the polyline(s) whose Sub-Area information you wish to clear and press Enter when complete.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas
Keyboard Command: untag_subarea
Prerequisite: A closed polyline with appropriate Sub-Area data.
Identify Sub-Area

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and reports it to the Command prompt.

Prompts

Pick polylines to check or search drawing [<Pick>/Search]: Press Enter to individually select Sub-Area polylines or Type S and press Enter to search the entire drawing.

Select sub-area polyline: Pick the polyline whose Sub-Area information you wish to identify and press Enter when complete.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas

Keyboard Command: id_subarea

Prerequisite: A closed polyline with appropriate Sub-Area data.

Report Sub-Area

This command displays the Sub-Area Category and Description information found on polylines in the drawing that have been tagged with the Tag Sub-Area command and reports the information to the standard Report Viewer.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas

Keyboard Command: report_subarea

Prerequisite: A closed polyline with appropriate Sub-Area data.

Hatch Sub-Areas

This command places a hatch pattern into polylines in the drawing that have been tagged with the Tag Sub-Area command.

![Hatch Settings dialog box]

Prompts

Hatch Name: Type in the name of a valid hatch pattern. A sample of the pattern will appear near the "Select Pattern" control.

Automatic Hatch Scale: Disable this toggle to manually control the size/density of the hatch pattern.

Hatch Scale: Specify the size of the hatch pattern. Larger Scale values create a less dense pattern.

Select Pattern: Use a visual dialog box approach to select a hatch pattern. The name of the hatch pattern selected displays in the Hatch Name control.

Select Color: Use a visual dialog box to specify the color of the hatch pattern.

Note:
• Any previous hatch patterns placed by the Hatch Sub-Areas command are first erased from the drawing.
• Hatch patterns are placed onto the LOTNET_HATCH_SUBAREA layer.

**Pulldown Menu Location(s):** Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas

**Keyboard Command:** hatch_subarea

**Prerequisite:** A closed polyline with appropriate Sub-Area data.

---

**Erase Sub-Areas Hatch**

This command removes the hatch pattern(s) placed with the Hatch Sub-Areas command.

**Pulldown Menu Location(s):** Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas

**Keyboard Command:** erase_subarea_hatch

**Prerequisite:** A Sub-Area with an appropriately placed hatch pattern.

---

**Label Sub-Areas**

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and uses the current text style to place the information as text into the drawing.

**Prompts**

**Text Size <4.00>:** Press Enter accept the specified text size or Type an alternate numeric text size and press Enter.

**Label area size [Yes/<No>]?:** Choose whether or not the area of the Sub-Area(s) should be labeled in the drawing.

**Layer name <LOT_SUBAREA>:** Press Enter to accept the layer name specified or type in the desired layer name and press Enter when complete.

**Note:**

• To remove Sub-Area Labels from the drawing, use the Lot Network Settings command.

**Pulldown Menu Location(s):** Civil → Area/Layout → Lot Network Sub-Areas, Survey → Area/Layout → Lot Network Sub-Areas

**Keyboard Command:** label_subarea

**Prerequisite:** A closed polyline with appropriate Sub-Area data.

---

**Input-Edit ROW Offsets**

This command defines the ROW offsets for the Road Network for Lot Networks. The ROW offsets are for the frontage polylines to the left and right of the centerlines. Besides the ROW, you can also define additional offset polylines to be drawn. These additional offset polylines do not effect the lot network.
Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_row
Prerequisite: None

Lot Network Road Network
This command develops the linework, geometry and labeling for subdivision, commercial and industrial sites by using the familiar Road Network interface and pre-defined settings. The program docks a dialog on the left of the screen identifying the geometry settings and all road files and leaves an active CAD screen and command line. You can save drawings and run virtually any standard AutoCAD command while within the docked dialog. Once you identify centerlines for the road network, the program detects intersections and end segments suitable for cul-de-sacs, and through input of design parameters for offset criteria, cul-de-sac dimensions and intersection transitions, the program will process the complete geometry layout, with output options including creating Lot files for later reference and a variety of labeling options for such items as Areas, Distances and Bearings. The road network settings are saved in a .RDN file.
Before running the Road Network, use the following procedure to setup the lot labeling settings and site boundary. Click the Lot Network Settings button. Note that you can use the Area/Layout Menu pulldown to access these commands as well. Select or create a lot network settings file. Next, select the Set Boundary icon. Select a closed polyline for the boundary around your site. Next select the Road Network icon. When prompted, select the .RDN file from the Existing tab. This is where the centerlines involved for the subdivision will be defined and added to the Road Name area of the panel. These centerlines are standard Carlson .CL files. Click a centerline and choose Edit. If a CRD file is requested choose or create a .CRD file. The Edit Road dialog appears. The centerline can be selected here and these centerlines can be edited on the fly if needed. For ROW Offsets, we are using the Row-OFF-a.Row file. Click Edit. The ROW offsets dialog displays. Use the defaults of 45’ left and right and note that additional graphics can be automatically generated by hitting Add and entering additional values, names and layers. Hit Exit.

Note also that Optional Input files can be attached to the process for roadway widenings based on the standard Carlson Road design tools of the same name. This is where a polyline indicating where the roadway template ID's should be tapered or widened is developed into a Centerline file and attached to the roadway template involved. Refer to the Road Design documentation for this information. Hit OK to close the Edit Road dialog. These settings can be set and altered for each road in the network.

Next click on one of the intersections you may have and select Edit Intersection. In the Edit Intersection dialog, the intersection's radii can be set. Click on the Front Left or Front Right to verify this. Hit OK when ready.
The program can also develop cul-de-sacs for the subdivision, although this example doesn't require one. To see how it works, click Add under Cul-de-sac's area of the panel. The Select Road for Cul-de-sac dialog appears. Select the road for the Cul-de-sac and the Edit Cul-de-sac dialog opens. Then as shown in the figure, choose whether the cul-de-sac occurs at the beginning or ending of the roadway, provide a cul-de-sac radius and filet radius and any other criteria to develop the graphics as desired. Since we do not have a cul-de-sac in this example we will skip this step.

Next select Settings at the bottom of the Road Network panel. The Radius is the default for new intersections. The radius for any existing intersection can be modified by selecting the intersection in the list and picking the Edit button. The Create Lots setting draws linework for lots for the specified geometry parameters. Otherwise, only the ROW polylines are drawn.
Use a radius of 25.0 and turn on the Create Lots toggle and click Settings. Set the values as shown in the Create Lot Settings dialog below. Then hit OK and OK to exit.

**Prompt For Each Area**: This option will pause to prompt for the target area as each lot is created.

**Target Lot Area**: The new lots will have this area +/- the Lot Area Tolerance under Lot Network Setting plus any effect from handling the Remainder.

**Minimum Frontage**: Controls the minimum lot perimeter length along the ROW.

**Use Setback For Minimum Frontage**: This option bases the Min Frontage check at the specified Frontage Setback from the ROW.

**Minimum Lot Depth**: This setting is the min distance from the ROW to the back of the lot for the lot side lines.

**Maximum Lot Depth**: This setting is the max distance from the ROW to the back of the lot for the lot side lines.

**Minimum Back Distance**: This setting is the min distance along the back of the lot perimeter between the two lot side lines.

**Interior/Back Reduce Offset**: For interior boundaries generated by the program between lots, this option reduces the number boundary vertices. A vertex is removed if it doesn't effect the boundary by more than the specified offset amount. This method is similar to the Reduce Polyline Vertices command.

**Edge Method**: The lot sides can be created perpendicular to the frontage ROW, back boundary or at a specific angle.

**Remainder**: This option determines how to handle any remaining area that is less than the target area after fitting as many lots as possible. The **Create Separate End Lot** will make a lot with this remainder area. The **Apply Equally to All Lots** will spread the extra area to all the lots. The **Add To Last Lot** will add the remainder to the last lot.
created making it larger than the target area. The **Create Back Lot Edge** makes a back lot edge that meets the target area at min frontage.

**Lot Type**: Sets the lot type for the new lots.

**Check Building Placement**: Checks that the building footprints fit within the lots for the specified setbacks.

![Lot Setback Parameters](image)

**Lot Setback Parameters**: These setting offset the lot perimeter inward for different sides of the lot.

**Min Setback Area**: This option checks that the lot area within the setbacks is at least this much.

In the Road Network panel click Save or Saveas to save these settings for your own experimentation.

Now Click Process to begin the lot layout. You will notice the ROW's and EOP's being generated, followed by the lot lines. Then areas are labeled and setbacks are created. Finally, the lotlines are labeled with distances, bearings and arc data.

![lot layout](image)

**Pulldown Menu Location**: Area/Layout

**Keyboard Command**: lotnet_rdn
Lot Network Linework

The following commands allow for the Lot Network to be manipulated after the processing. The commands allowing this are:

Adds a ROW polyline into the model. By clicking this command, the software asks for the user to select the new ROW polyline. It then reprocesses the site based on this new ROW data and relocates the EOP for this portion of the roadway.

This command adds a lot edge to the model. The software may request a Lotnet Settings file and if so create or select it. The software prompts with: Select Edge linework to add to model: Select the polyline you drew in the lot representing the new lot edge. The software reprocesses the site based on this new data and redevelops the lot layout accordingly.

This takes a property line out of the model. Select the edge in question when prompted.

This command allows for adding a new property corner to an existing lotline. Simply select the lot edge in question and then pick the point to be added using a snap or other means.

This command allows for moving a lot corner.

This command allows for eliminating a lot corner. Simply select the lot edge in question and then the corner to be removed.

Pull down Menu Location: Area/Layout
Keyboard Command: Lotnet_Add_Row, Lotnet_Add_Edge, Lotnet_Remove_Edge, Lotnet_Point_Add, Lotnet_Point_Edit, Lotnet_Point_Remove
Prerequisite: None

Lot Network Subdivide Area

This command subdivides an area into smaller parcels. The command displays the Create Lot Settings dialog. Once all settings are values have been entered, click on the OK button.

Next you are prompted to Pick inside area to subdivide:

Next, the right-of-way adjacent to your area to subdivide is highlighted. You are prompted to Pick end of frontage to start lots: Use your left mouse button to pick a point near one end of the highlighted right-of-way. New lots will be created starting from this end of the right-of-way.

Note: All previously created lots will be re-drawn and re-labeled if the setting for "Automatic Label Updates" has been toggled ON in the LotNet Settings dialog box.
Prompt for Each Area: Enabling this setting will prompt you to specify the area for each Lot as it's created.

Target Lot Area: This setting establishes the minimum lot area for each lot created using this command. Target Lot Area can be specified using Acres or Square Footage.

Minimum Frontage: This setting establishes the minimum width, along the front Right of Way, of the newly created lots.

Use Setback for Minimum Frontage: Enabling this option measures the minimum frontage at the setback location instead of along the front Right of Way.

Frontage Setback: This setting establishes the distance off the front right-of-way for the front setback.

Minimum Lot Depth: This setting establishes the minimum depth of new lots created with this routine.

Maximum Lot Depth: This setting establishes the maximum depth of new lots created with this routine.

Minimum Back Distance: This setting establishes the minimum width of the rear lot line. Setting this to "0" allows for a pie-shaped lot.

Interior/Back Reduce Offset: This setting establishes the maximum distance interior or back lot lines can be shifted or trimmed in order to meet other setback rules.

Edge Method: This setting establishes the angle between the front right-of-way and new lot lines. You are able to specify that new lot lines be drawn: Perpendicular to ROW, Perpendicular to Back Lot Line or at a Specific Angle.

Remainder: This setting allows you to distribute the area that is left over after creating new lots. The remaining area can be distributed using one of several methods: Apply Equally to all Lots, Create Separate End Lot, Add to Last Lot and Create Back Lot Edge.

Lot Type: This setting allows you to specify the Lot Type for new lots created using this routine. Lot Types are defined in the LotNet Settings dialog box.

Check Building Placement: This setting allows you to establish front, side and back setback distances for building placement along with a minimum allowable area for front setback. Building sizes are defined in the LotNet Settings dialog box.
Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_subdivide_area
Prerequisite: None

Size Lot by Frontage

This command provides the ability to resize a Lot associated with the current Lot Network .LTN file based on a user-specified amount of Lot Frontage.

Prompts

Pick inside lot to adjust: Identify the interior portion of a Lot whose Frontage is to be adjusted.
Select lot edge to adjust: Choose a side Lot edge that is common to two Lots. The Current Area and Current Frontage of the selected Lot is reported.
Frontage (ft): Type in the new Frontage amount and press the Enter button.

Note:
- To specify an alternate .LTN file, use the Lot Network Settings command.

Pulldown Menu Location(s): Civil → Area/Layout → Lot Network Areas, Survey → Area/Layout → Lot Network Areas
Keyboard Command: lotnet_ssfront
Prerequisite: A processed set of Lots and their graphical entities created by the Lot Network routines.

Lot Network Sliding Side Area

In this routine a lot side can be altered to reflect a new target area. It will hold its angle and slide along the front and back lot lines until it has achieved the desired area. When running the routine, Select the lot in question when asked to pick inside lot to adjust and then select the lot edge to adjust. Then the prompt asks Acres/<Enter Target Area(sf)>: Type in the desired area you are trying to obtain and the system computes it.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_ssarea
Prerequisite: None

Lot Network Hinged Area

In this routine a lot side can be altered to reflect a new target area. It will hold a lot corner and pivot, or rotate until it achieves the desired area. The procedure is as follows:
Pick inside lot to adjust: Select a point inside the lot to modify.
Select lot edge to adjust: Select the edge that will move.
The routine will report the current area to you and then ask for your desired area.
Current Area: 22494.5 SF 0.516 Acres
Acres/<Enter Target Area (sf)>: 10000

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet_harea  
**Prerequisite:** None

---

**Lot Network Labels**

These are a collection of commands to draw lot network area, line and arc labels.

Deletes the labels in the model and re-labels the linework based on the LTN file settings.

Deletes the labels in the model and re-labels the linework.

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet_update, lotnet_redraw  
**Prerequisite:** None

---

**Lot Network Report**

This command generates a summary report of the areas and number of lots in the lot network model. For a detailed report of the lot data, output the lot network to a .lot file and run the Report function inside Lot File Manager.

**Lot Network Report**

**File:** C:\Carlson Projects\Clearwater Oaks.ltn

**Total Area:** 20.520 acres, 893839.8 sf  
**Lot Area:** 17.600 acres, 766648.4 sf  
**ROW Area:** 2.920 acres, 127191.3 sf  
**Other Area:** 0.000 acres, 0.0 sf  
**Number of Lots:** 50

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet_report  
**Prerequisite:** None

---

**Lot Network Inspector**

This command shows a dynamic report of the lots as the cursor passes over them. The program has a small dialog that shows the lot number, area, perimeter, frontage and Lot type.
**Check Lot Network Parameters**

This command compares area and frontage of Lots associated with the current Lot Network file (.ltn) against user-specified area and frontage values.

Enabling the "Check ROW Offsets" option will also check for proper right-of-way distances using a specified centerline file (.cl) or (.rdn) file.

A detailed report is generated that displays the Lots that meet or do not meet the area and frontage minimums along with the coordinates of points along Lot frontage that violate the right-of-way value specified.

**Minimum Lot Area:** Specify the smallest acceptable area a Lot can be to "pass the test" and the appropriate unit of measure.

**Minimum Frontage:** Specify the smallest allowable amount of street frontage the Lot must have in order to "pass the test."

**Check ROW Offsets:** This setting allows you to specify the full right-of-way width for the road defined by the centerline file (.cl) you specify.

**Note:**

- To specify an alternate .LTN file, use the Lot Network Settings command.
- To "browse" over lots already in a drawing, use the Lot Network Inspector command.

**Find Lot Name**

This command displays a temporary indicator in the drawing showing the location of a Lot associated with the current Lot Network .LTN file.

**Note:**

- To specify an alternate .LTN file, use the Lot Network Settings command.
- To "browse" over lots already in a drawing, use the Lot Network Inspector command.

**Prompts**
Lot Network File to Process dialog

**Locate an existing .LTN file**

**Lot name to find:** Type in the Name (usually the Lot Number) of the Lot you wish to locate and press Enter

**Pulldown Menu Location(s):** Civil → Area/Layout → Lot Network Utilities, Survey → Area/Layout → Lot Network Utilities

**Keyboard Command:** lotnet_find

**Prerequisite:** A processed set of Lots created by the Lot Network routines.

---

**Lot Network Renumber Lots**

This command allows you to renumber the lot number for selected lots. The program prompts for the Starting Lot Name: where the new value can be types, such as 200 for the new starting number. It then says Pick point inside lot to start renumbering: so you would pick inside the desired lot. The routine then asks for the Next direction point for renumbering: and you must pick into the next lot to continue or cross over several lots in one pick to include all of those lots in the renumbering process.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet_renum

**Prerequisite:** A processed set of Lots created by the Lot Network routines.

---

**Lot Network - Assign Lot Type**

This command allows you to assign a new Lot Type to Lots in a Lot Network by dragging a line across the Lots to be re-assigned.

**Note:** Lot Types must have already been defined through the LotNet Settings dialog box.

---

**Prompts**

**Set Lot Type dialog:** Select the "Default" or other pre-defined Lot Type.

**Pick a point inside lot to start re-assigning:** Use the left-mouse button to drag a multi-segmented line across all the Lots to be re-assigned to the selected Lot Type. Press Enter to finish.

**Pulldown Menu Location:** Area/Layout → Lot Network Utilities

**Keyboard Command:** lotnet_type

**Prerequisite:** A lot network and pre-defined Lot Types

---

**Lot Network Output To Lot File**

This command will develop a .LOT file containing the points to define the lots. The points are stored into the current coordinate file. The .LOT file by the collection of Lot File commands including Lot File Manager.
Set Lot File

This command sets the lot (.LOT) file name that other lot routines will automatically reference. The lot (.LOT) file stores a list of lots with each lot being a list of point numbers which reference coordinates stored in a coordinate (.CRD) file.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet, lotfile
Prerequisite: a lot network

Design Lot

This command creates lot definitions that are stored in a lot (.LOT) file. The lots are defined by entering a sequence of point numbers. The point numbers reference coordinates from the current coordinate (.CRD) file. Each lot has a lot name and block name. The lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines. Curves are entered by first specifying the PC point number, then type R for radius and enter the radius point number followed by the PT point number.

Prompts

Lot Name <1>: 105
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
If the figure that you are entering is a centerline, then you could use this as the starting station of the centerline.
Starting point number: 17
Point number (R-RadiusPt,U-Undo,Enter to end): 18
Point number (R-RadiusPt,U-Undo,Enter to end): 19
Point number (R-RadiusPt,U-Undo,Enter to end): R
Radius point number: 20
Use large included angle for curve (Yes/<No>)? press Enter
End of curve point number (R-RadiusPt,U-Undo,Enter to end): 21
Point number (R-RadiusPt,U-Undo,Enter to end): 22
Point number (R-RadiusPt,U-Undo,Enter to end): 17
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
Enter another lot (<Yes>/No)? N
**Pulldown Menu Location:** Area/Layout > Create Lots  
**Keyboard Command:** mklot  
**Prerequisite:** Points in a coordinate (.CRD) file

---

**Polyline to Lot File**

This command will create lot (.LOT) files from selected polylines. The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found. Each lot has a lot name and block name. Lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines.

---

**Prompts**

**Polyline To Lot File Options Dialog** *enter in values*

After entering in the Starting Point Number, points will be automatically numbered starting from this value.  
**Select lot polyline:** *pick a polyline*

Select lot polyline:  
Lot Name *<LOT 19>*:  

Created 3 lot points.  
Select lot polyline (Enter to end):  
Lot Name *<LOT 20>*:
Lot File by Pick Interior

This command is used to create a lot by picking a point, and having the program figure the enclosing linework. The linework do not need to be closed themselves but selected together they should define closed areas. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Lot File Manager. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Lot File Manager. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Lot File Manager. If a point number is at the corner of four lots, moving that one point number will update all four lots.

Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.
Lot File by Interior Text

This command creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Lot File Manager. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Lot File Manager. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Lot File Manager. If a point number is at the corner of four lots, moving that one point number will update all four lots.

Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Selected objects: press Enter
Created 3 lots.

Lot Manager

This command combines input, edit, draw and report lot capabilities into one command.
Main Dialog

In the main dialog, there is a spreadsheet list for the lot names along with the block name, lot type and group assignment for each lot. You can edit these values directly in the spreadsheet. There are also function buttons as follows:

**Open:** selects another Lot File to process.
**Save:** saves the lot data to the current lot file.
**SaveAs:** prompts for another file name to save the lot data to.

**View:** The View options control drawing effects when you highlight lots in the spreadsheet list.
**Zoom Current:** zooms the display view to include the selected lot.
**Highlight Current:** highlights the perimeter of the selected lot as a dashed line.
**Hatch Current:** fills in the selected lot with a hatch.
**Restore View on Exit:** on leaving Lot Manager, this option sets the display to the original position before running Lot Manager.

**Lot Selection:** Many of the functions such as Draw process only the lots that are in selected mode. You can toggle which lots are selected with the buttons in the Selection spreadsheet column. You can also use the buttons in the Selection section to select the lots to process.

**Select All:** marks all the lots as selected.
**Clear All:** unselects all the lots.
**Invert Selection:** flips currently selected lots to unselected status and currently unselected to selected status.
**Load Selection:** sets the current selection status from a .LSS file.
**Save Selection:** saves the current selection status to a .LSS file.

**Add:** creates a new lot. The new lot name is automatically generated by incrementing from the highest lot name.
**Remove:** deletes the currently selected lots.
**Copy:** creates new lots as copies of the currently selected lots.
**Edit Current:** brings up a dialog editor for the highlighted lot (see below).
**Move Up/Down:** changes the order of the highlighted lot in the list.
**Sort By Block:** sorts the lots by block name order first and then by lot name within each block.
**Sort By Lot:** sorts the lots by lot name only without using the block name.
**Draw:** draws the selected lot perimeters and annotation (see below).
**Report:** reports the selected lots (see below).

**Original Coordinates Utilities:** has methods for tracking lot coordinate transformations of the current coordinates relative to the original coordinates.
Export: output selected lots to a new lot file as a way to make a subset lot file.

Edit

This dialog allows you to edit the lot name, block name, group, coordinate file, starting station, ending station and the point numbers that define the lot. A curve is specified by the PC, radius point and PT point numbers. The Large Arc option indicates a curve with an included angle greater than 180 degrees. The Select button allows you to specify a new name or location for the coordinate file associated with the lot.  
**Add:** adds a new point to the lot.  
**Remove:** removes the highlighted point from the lot.  
**Move Up/Down:** changes the order of the highlighted point in the list.  
**Reverse:** reverses the order of the points.  
**Set POB:** sets the point of beginning, starting point, to the currently highlighted point.

![Edit Lot dialog box](image)

Draw

The Draw routine allows you to draw polylines for the lot perimeters as well as annotate the lot linework and areas.  
**Draw Lot Polylines:** The layer for the polylines is set by the Lot Type which is defined in Define Lot Attributes. If the Lot Type is not defined, then the polyline are drawn in the current layer.  
**Label Lines and Arcs:** Labels the bearing, distance, and curve data using the Auto-Annotate command. See Auto-Annotate for more details.  
**Label Areas:** Labels the area, and optionally the name of the selected lots using the Area Settings dialog. See Area Defaults for more details.  
**Hatch Areas:** Hatches the lot areas.  
**Create Esri MSC Attributes:** Defines an Esri MSC format lot feature in the drawing with the lot attributes.  
**Erase Previous Entities:** Erases lot polylines and labels from earlier runs of Draw to avoid duplicates.
Report

The Report routine has several types of reports.

**Report Areas Only:** When checked only the lot name, block name, and area are included in the report.

**Report Stations:** Controls whether to report the distance along the lot perimeter.

**Report Elevations:** Controls whether to report the elevation from the coordinate file for each lot point.

**Report Point Descriptions:** Controls whether to report the description from the coordinate file for each lot point.

**Add Page Break between Lots:** Formats the report so that each lot definition begins on a new page when printed.

**Use Report Formatter:** When checked, the report is output to the Report Formatter where it can be customized as well as exported to Microsoft® Excel or Microsoft® Access. See Report Formatter in for more details.

**Report Closure By:** If the Start/End Coordinates method is used, closure error distance is typically 0 (perfect closure—you end where you start). If the Angle/Distance Precision method is used, then the actual bearings and distances (computed from the coordinates) in the report are used, and due to the rounding used to present the bearings and distances, minute closure errors will occur which will be reported.

**Report Precision:** Specify the decimal precision for reporting coordinates, distance and angles on the report. The precision for the areas is defined in the Area Defaults command.

**Unequal Radius Tolerance:** When reporting the curve data for a lot, the two radial lengths are compared. If the difference in their length is more than this value, it is noted on the report.

**Check Lot Report:** Checks that the area for all the lots assigned to a Group Block-Lot add up to the area of the area of the enclosing group lot.

**Lot Report:** Creates a report using the report settings.

**Legal Description Report:** Writes a legal description using the same routine as the Legal Description Writer command. See the Legal Description Writer section of the manual for more details.
Lot Report
Lot File: C:\sample\CivilDemo.lot
CRD File: C:\sample\CivilDemo.crd

LOT 55 OF BLOCK 1, TYPE: LOT

PNT# Bearing Distance Northing Easting Station
36 3374.827 4631.668 0.000
Radius: 642.845 Length: 85.660 Chord: 85.597 Delta: 07°38'05''
Chord BRG: S 60°07'05'' W Rad-In: N 33°41'58'' W Rad-Out: N 26°03'53'' W
Radius Pt: 8 3909.649,4274.994 Tangent: 42.894 Dir: Right
Tangent-In: S 56°18'02'' W Tangent-Out: S 63°56'07'' W
Non Tangential-Out

41 3332.181 4557.451 85.660
42 3489.384 4480.558 260.660
Chord BRG: N 60°07'05'' E Rad-In: N 26°03'53'' W Rad-Out: N 33°41'58'' W
Radius Pt: 8 3909.649,4274.994 Tangent: 31.217 Dir: Left
Tangent-In: N 63°56'07'' E Tangent-Out: N 56°18'02'' E
Non Tangential-In Non Tangential-Out

37 S 33°41'58'' E 175.000
36 3374.827 4631.668 498.001
Closure Error Distance> 0.00032 Error Bearing> N 70°14'59'' E
Closure Precision> 1 in 1550913.7 Total Distance> 498.001
LOT AREA: 12950.1 SQ FT OR 0.3 ACRES

Pulldown Menu Location: Area/Layout
Keyboard Command: editlot
Prerequisite: None

Lot Inspector
This command activates a small pop-up window that when you place your pointer into a lot file area, the details of that lot file will be displayed in the Lot Inspector window.
Prompts

Move pointer inside lots (Pick to edit, Enter to End) hover crosshairs above lot(s)

Pulldown Menu Location: Area/Layout
Keyboard Command: lotinspector
Prerequisite: None

Right-of-Way Crossing Table

This command will create a table using user selected information and user defined table features. A polyline is selected that crosses one or more lots. Lots must be defined in a Lot file prior to running the command. In the following example the polyline is labeled as a Pipeline.

When the command is started the user is presented with the Lot Crossing Settings dialog box. There two tabs; Label Fields and Settings and Table Settings.
**Available Labels:** This is the list of information that may be included in the table.

**Used Labels:** These are the items that have been selected to be in the table. They are placed in the table in the order listed. The green up and down arrows will move used labels up or down in the list.

**Add:** Clicking the Add button will add the highlighted labels in the available list to the used list.

**Remove:** Clicking the Remove button will remove labels highlighted in the used list and display in the available list.

**Setup:** Setup opens the Field Settings dialog for the Used Label that is highlighted.

**OK:** Clicking the OK button will proceed to the selection of the crossing polyline.

**Cancel:** ends the command with no table being created.

**Load:** Loads previously saved settings so table created match previous tables.

**Save:** Saves the settings as currently displayed for use on future tables.

**Help:** Load this file.

**Sheet Width (in):** This value defines the width of the table. If set too small the text in the table will overlap.

**Table Layer:** Select an existing layer to draw the table on using the Select button or use a new layer by typing the name in the edit field.

**Table Color:** The use can specify a color for the table gridlines using the Select button. Bylayer will use the color assigned to the Table Layer for the grid lines.
Table Title: A title can be specified for the table by typing the desired title in the Table Title field. See example below.

Title Text Color: This specifies the color for the Table Title text.

Title Text Style: This specifies the text style for the Table Title text. Be sure the style specified is defined in your drawing.

Title Text Size Scaler: This specifies the plotted height of the Table Title text. The table is drawn in model space. The height of the text in model space is the Text Size Scaler multiplied by the horizontal scale in Drawing Setup.

Use Table Tile Background Color: This option allows the user to specify a background color for the Table Title.

Use Table Header Background Color: This option allow the user to specify a background color for the Table Header row.

Use Table Contents Background Color: This option allows the user to specify a background color for body of the table.

Use Table Contents Alternating Background Color: If the Table Contents Background color is being used, This option allows the user to specify a second color to use on alternating rows of the table body.

The Field Settings dialog box is opened by double-clicking a Used Label or highlighting a Used Labels and clicking the Setup button.

Row Title: Row Titles are the Used Labels that were selected Label Fields and Settings tab.

Text Style: This specifies the text style to be used for the current row text. You may use the Select button to choose a text style. Be sure the selected text style is loaded in the drawing.

Text Style Scaler: This specifies the plotted height of the current row text. The table is drawn in model space. The height of the text in model space is the Text Size Scaler multiplied by the horizontal scale in Drawing Setup.

Text Color: This specifies the color for the current row text. You can use the Select Color button to choose the color from a pallet. Bylayer uses the color of the Table layer for the text.

Prefix: This places the user provided prefix text with the row entries. An example would be prefixing lot numbers with the word Lot.

Suffix: This places the user provided suffix text with the row entries. An example would be using ft for feet as a suffix for a length.

Justification: Users can specify, Left, Center or Right text justification.

Calculated Numeric Values

Table numeric values that are calculated, like area or lengths, have the two following controls in addition to those listed above.

+/-. Users may specify a +/- be used as a prefix or suffix. The default is None, not used.

Precision: Decimal precision for calculated numeric values can be set to zero and up eight decimal places.

OK: Saves changes and closed the Field Setting dialog box.
Cancel: Closes the Field Settings dialog box without saving changes.
Help: Accesses this documentation.

<table>
<thead>
<tr>
<th>PIPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOT</td>
</tr>
<tr>
<td>BLOCK</td>
</tr>
<tr>
<td>Feet</td>
</tr>
</tbody>
</table>

**Prompts**

**Pick a polyline for lot crossings:** Select polyline crossing lots
**Starting Station <0.0 >:** Enter desired starting station
**Ending Station <1642.88 >** Accept full length or enter ending station to process a part of the polyline.

**Pick location for report table:** Select location in drawing for table

**PullDown Menu Location(s):** Survey Module: Area/Layout > Lot File Utilities > Right of Way Crossings Table

**Keyboard Command:** lotcross

**Prerequisite:** Polyline and Lot File

**Define Lot Attributes**

This command allows the user to define the Lot Type, Lot Attributes and Point attributes. With the use of the opening Lot Attribute Definitions dialog box, shown below, this routine allows you to edit, add, remove or reposition all of these definition types. You can save the selected data to a new Lot Attribute Definition file (LTD). You are also able to load an existing LTD file to work with.

The **Lot Types** section of the dialog lists out the Lot Type and the layer associated with it.
You can set up different lot types and a layer. When the lots are drawn, the layer name is used per lot type. Also, Lot Types are used in the lot report. There are also Lot Attributes, which are additional fields that you can define for the lots, such as deed number. And there is also Point Attributes.

**Edit/Add:** Both the Edit and the Add buttons bring up the same Lot Type dialog, shown here. You can edit an existing lot or add a new one.

The Lot Attributes section asks for the Name and to enter the Data Type.

**Edit/Add:** Edit or add the name of the lot attribute. Choose from one of the four options for Data Type: Real, Integer, String or Document.

Similarly, the Point Attributes section also asks for the Name and to enter the Data Type.

**Remove:** Any of the Remove button will remove a lot type, lot attribute or point attribute from the list above it, depending upon which Remove button you use.

**Up/Down (all three):** Types and attributes can be repositioned.

**Track Original Coordinates:** This option will track the original coordinates of the lot so that this record may be kept for your future usage and needs.

**Load:** A Lot Attribute Definition file (LTD) can be loaded.

**SaveAs:** A new Lot Attribute Definition file (LTD) can be saved.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotattr

**Prerequisite:** None

---

**Import Lot File From MDB Database**

This command will import a lot file from a Microsoft Access database file (.MDB) format.

---

**Prompts**
Export Lot File to MDB Database

This Lot File Utilities command will export a lot file to a Microsoft Access database file format.

Prompts

Lot File to Export dialog *select existing .LOT file*
Database File to Write dialog *select existing or create a new .MDB file*

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotexport
Prerequisite: A lot (.LOT) file

Export Lot File To Old SurvCADD

This Lot File Utilities command will export a Carlson lot file to SurvCADD .LOT file format.

Prompts

Source Lot File to Export dialog *select existing .LOT file*
Destination Lot File To Write dialog *create a new .LOT file*

Pulldown Menu Location: Area/Layout > Lot File Utilities
Keyboard Command: lotexport2
Prerequisite: A lot (.LOT) file

Set CRD File for Lot Files

This command allows you to set the coordinate (.CRD) file that is associated with any number of lot (.LOT) files. This can be useful if the name or location of the coordinate (.CRD) file is changed. In the Set CRD for Multiple Lots dialog, press the Select .LOT files button to select any number of lot (.LOT) files. They are added to the list. Next, press the Select .CRD file button. After you have selected the files, press the Process button.
Pulldown Menu Location: Area/Layout > Lot File Utilities  
Keyboard Command: lotscrd  
Prerequisite: Existing lot (.LOT) file(s)

Lot File to Centerline
This command creates a centerline (.CL) file from a lot (.LOT) file. Since the lot definitions contain a series of points and a starting station, the lot (.LOT) file contains the necessary data to create a centerline. The Select Lot to Convert dialog lists the available lot names in the current lot (.LOT) file. Select a single lot to process, then specify the centerline (.CL) file name to create.

Prompts
Centerline File to Write dialog enter new centerline (.CL) file name  
Select Lot to Convert dialog select a lot from the list

Pulldown Menu Location: Area/Layout > Lot File Utilities  
Keyboard Command: lot2cl  
Prerequisite: None

Annotate Menu
These menus include commands for labeling lines with bearing/azimuth and distances, special lines, coordinates, curves, curve tables and line tables. The precision of labeled distances and coordinates are set and controlled with the Annotate Defaults command.
Annotation Defaults

This command sets the defaults for the annotation menus and controls the way various annotation commands work. Some of these defaults can be changed globally by running the Configure command, which changes the file COGO.INI so that every time you start Carlson, the new defaults are set. When this menu option is selected the Annotate Defaults dialog appears.

This dialog is broken into 5 tabs: General, Angle, Distance, Serial Lines and Parallel Lines.

General Tab

This tab is used for settings that apply to all annotation types.
**Horizontal Scale:** This is the horizontal scale for the current drawing. This value can also be set by using the Drawing Setup command on the Settings menu.

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line.

**Line Type Spacing:** Specifies the distance between the symbols on special line types.

**Line Type Text Scaler:** This value multiplied by the horizontal scale specifies the size of the symbols of special line types.

**Arc Length Label:** Specifies the prefix label for arc length labels.

**Arc Text Spacing Factor:** This variable controls how close letters will be spaced when labeling arcs. The lower the number, the closer the spacing. The higher, the farther apart. (The suggested range between 0.8 and 1.5)

**Use MText:** This option creates the labels as MText instead of standard Text entities.

**Label Flip Tolerance (degrees):** Gives extra tolerance for label flipping for readability. Labels draw in the north-west quadrant that are within this number of degrees to due-north will be drawn upside down.

**Previous Labels:** Specifies if previous labels for the for the set of linework being annotated are kept or deleted. Setting values are Retain, Erase, Prompt Before Erasing.

**Draw Leaders to Endpoints on Lines:** This option creates leader lines (crow's feet) between the distance annotation and the line segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the distance label.
Distance Labels Only: When checked, leaders will not be drawn unless the label includes a distance.

Leader Size Scaler: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the line segment is too short, the leader is shortened to fit.

Height Scaler: This option controls the height of the leader.

Offset Scaler: This option controls the distance between the line endpoints and the leader endpoints.

Arrow Scaler: This option controls the arrowhead size for leader styles with arrows.

Leader Style: This option determines which of the five styles of endpoint leaders to use. The five styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot and Dashed.

Leader Layer: This option determines the layer for drawing the leader.

Draw Leaders to Endpoints on Arcs: This option creates leader lines (crow's feet) between the arc segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the arc label.

Leader Size Scaler: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the arc segment is too short, the leader is shortened to fit.

Offset Scaler: This option controls the distance between the arc endpoints and the leader endpoints.

Leader Style: This option determines which of the five styles of endpoint leaders to use. The five styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot and Dashed.
Leader Layer: This option determines the layer for drawing the leader.

Report Delta Angle as 1/2 Actual Angle: The angle value in the label will be 1/2 the actual angle.

Angle Tab:

This tab is for settings that apply to angle labels:

Angle Layer: This specifies the layer to be used for angle labels.

Angle Text Style: This specifies the text style to be used for angle labels.

Bearing Prefix and Suffix: Specifies the prefix and suffix text for azimuth labels.

Azimuth Prefix and Suffix: Specifies the prefix and suffix text for azimuth labels.

Bearing Annotation Precision: Specify the display precision for bearing labels.

Angle Separator: Choices are Symbol, Hyphen, Space, Other. When Other is chosen the Deg. Min. and Sec. fields are enable to allow the user to enter custom angle separators.
**Bearing Direction Method:** Choose the orientation of the bearing. This controls how lines selected for bearing or azimuth annotations will be referenced.

**Toward Picked End:** If this option is chosen, the line will be labeled in the direction of the endpoint that is closest to the point where you selected the line.

**Away from Picked End:** This labels the line in the direction away from the closest endpoint.

**North Only:** This option controls whether bearing annotations will always be labeled in the north quadrants (NE or NW) and never in the south quadrants.

**East Only:** This option controls whether bearing annotations will always be labeled in the east quadrants (NE or SE) and never in the west quadrants.

**By Linework:** This option labels the line in the direction that the line was drawn.

**Label Geodetic Mean Angle:** Instead of labeling the direct coordinate bearing between two points, this option labels the geodetic mean angle which is the average of the geodetic bearings at the two points. This method converts the drawing coordinates to lat/lon and calculates the convergence angles for both points. The projection must be defined under Settings -> Drawing Setup.

**Strip Spaces in Bearing Labels:** This option causes the spaces in bearing labels to be removed.

**Add Spaces in Bearing Labels:** This option puts spaces between the degree, minutes, and seconds numbers.

**Strip Zero Minutes and Seconds:** This option shortens the label by dropping either seconds and or minutes and seconds when they are equal to zero.

**Bearing Quadrant Labels:** These settings control the labels for the north/south prefix and east/west suffix for bearing labels.

**Label Cardinal Angles by Name:** When checked, the user is allowed to enter the labels that will be used for each of the four cardinal angles.

**Draw Bearing Leaders:** This option creates a direction arrow with the bearing annotation as shown below.

![N 87°06'01" E](image)

**Position Leaders To Side:** This option draws the bearing leader to the right side of the bearing label. Otherwise the leader is drawn above the label.

**Distance Tab**

This tab is for settings that apply to distance labels:

**Distance Layer:** This specifies the layer to be used for distance labels.

**Distance Text Style:** This specifies the text style to be used for distance labels.

**Distance Suffix:** This specifies the suffix that is appended to distance annotations.
Dist. Units: This specifies the units used for distance labels. Choices are Decimal, "Feet and Inches" and Both. Decimals is used to set the number of decimal places in decimal based distance labels. Dist. In Inches is used to control the precision of the fractional portion of the inch label, from 1/2 to 1/256th of an inch.

2nd Scaled Distance Options: This option labels determines if a 2nd scaled distance is included in distance labels. This 2nd distance is scaled by the Report Scale Factor set in the Drawing Setup dialog. Choices for this option are "Label 1st Only" (label distances in current drawing units only), "Label 1st and 2nd" (label distances in both current drawing units and scaled by the Report Scale Factor) and "Label 2nd Only" (label distances scaled by the Report Scale Factor Only).

Decimals: This option sets the number of decimal places for the second scaled distance label.

Label: This variable will be assigned as a suffix to the second scaled distance label.

Use Brackets: This labels the second scaled distance value inside [brackets].

Drop Trailing Zeros in Distances: This option allows you to drop trailing zeros on distance labels.

Series Lines Tab

This tab is for settings that apply to Series Lines labels (See the section "Auto Annotate" for a detailed description of series line handling).

Text Size Scaler: This value is multiplied by the horizontal scale value to set the text size units for serial lines.
**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for serial lines.

**Angle Layer:** This specifies the layer to be used for angle labels on serial lines.

**Angle Text Style:** This specifies the text style to be used for angle labels on serial lines.

**Distance Layer:** This specifies the layer to be used for distance labels on serial lines.

**Distance Text Style:** This specifies the text style to be used for distance labels on serial lines.

---

**Parallel Lines Tab**

This tab is for settings that apply to Parallel Lines labels (See the section "Auto Annotate" for a detailed description of parallel line handling).

![Annotate Defaults](image)

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units for parallel lines.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for parallel lines.

**Angle Layer:** This specifies the layer to be used for angle labels on parallel lines.

**Angle Text Style:** This specifies the text style to be used for angle labels on parallel lines.
Load/Save: Choose these options to load an existing annotation defaults file (.ADF) or save a new one, which will contain your current selections.

Pulldown Menu Location: Annotate
Keyboard Command: LDEF
Prerequisite: None

Auto Annotate
This command allows you to select a group of lines, arcs and/or polylines to be labeled. It allows for any combination of line and distance labeling, and also any combination of arc labeling.

You can position the features of the labels, once in the Auto-Annotate dialog, by using the Row, Side, Order, Orientation and Position Types options, all found under Lines tab. For Arcs, you can select the Arcs tab and determine the type of auto-annotating you would prefer for arc entities. As you select different options, you can see the changes in the preview display of the entry dialog. You will select the Angle Format in terms of Bearing, Azimuths and Gons and there is an important feature that allows you to avoid label overlaps. This is done by applying specific, user-defined settings. When labeling arcs, there are options to set the label prefixes for curve annotation. The Settings button will bring you to the Annotation Defaults dialog, as explained in a previous section. Defaults will restore the prior settings.

Apply Label Settings by Layer brings up another dialog box which allows you to import from file, or load, predetermined configurations. There is an option to have different label settings applied by layer. Apply Label Settings By Layer allows you to set, load, and save your preferred variables.

The Avoid Label Overlap option can bring up a special dialog called the Overlap Manager. This screen, which contains extra tools for, as an example, sliding or stacking the labels that are overlapping and conflicting with drawing entities, gives you the real-time ability to move along the plan and make your corrections. This also will help you to avoid overlapping with other labels, text, symbols and linework – including fence and utility lines. In this Overlap Manager, docked on the left side of the screen. it is recommended that you use the Back and Next button frequently in order to review, adjust and correct your drawing.

Auto-Annnotate dialog starts with the Lines (tab).
Angle/Distance: Allows you to enter the what row the Angle label is on, what side and the order of the label on the linework. The same applies for Distance labels. Notice the preview display changing.

Row: Using numbers (1 or 2), or choosing None, you can determine the order and appearance of the descriptions. Note the change in the preview display.

Side: Choose inside or outside of the line.

Order: If you determine that the annotations are to be on the same row and same side of the line, then you must pick the order in which they will appear, from left to right.

Justification: This option gives the ability to left or right justify labels at ends of line or center justify the labels.

Orientation: This offers this choice between parallel or perpendicular with regards to the labels' orientation to the line being labeled.

Position Types: Determined how each label is placed in relationship to the line and the other label.

Angle Format: Bearing, azimuths or gons are the choices.

Combine Common Angles: This allows the user to reduce label clutter by minimizing labeling of serial and parallel linework. Choices are Off, Series, Parallel and "Series and Parallel". Series common angles are those where serially connected linework share the same angle. Common series angles are labeled at the mid-point of the series of connected line segments. When series common angles are selected they may be drawn stacked on the same side as the distance labels or on the opposite side from the distance labels. Also, for serial common angles the total distance may be included in the label. Parallel common angles are those where adjacent areas share parallel lines that include the line that bisects the areas. In this case, only the outer-most lines of the set of parallel lines will be labeled with the angle.

The common angle labels have separate settings for layer, style, size and offset. Please see the section "Annotate Defaults" for information on how to control these settings.

The following example shows the results of combining common serial labels, including totaling of the distances:
Compress Labels for Short Lines: When angle and distance labels are being placed on the same side and row, this feature allows the user to place the label on different rows in the case that the label will not fit on the line otherwise. The options are Off, "Angle Above, Distance Below", "Distance Above, Angle Below", "Stacked Angle-Distance" and "Stacked Distance-Angle".

Add Space Between Angle and Distance Labels: When angle and distance labels are being placed on the same side and row, this feature allows the user to have the angle and distance labels spread apart from each other as allowed by the length of the line being annotated.

Use Line Tables: Line tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Line Table Scaler" is enabled.

To Line Table Scaler: If the length of the line is less than this minimum, the line is labeled as a line table entry. The To Line Table Scaler is relative to the current horizontal scale and represents the length of the line in plotted inches.

Starting Table Number: User choice. You might change this because perhaps you have another group of line labels, in table form, in the drawing. Line table entries are numbered sequentially beginning at the line Starting Table Number. The location for the line table can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current line table. To set the location for the current line table, run the Table Header command in the Annotate > Line/Curve Table menu.

Auto-Annotate dialog box, by selecting the Arcs tab, displays the options for auto-annotating arcs. The columns are described, followed by the rest of the options.
**Label:** Here you might alter slightly the defaults by entering a letter or acronym that will represent the type of calculation. Or you could leave it alone.

**Row:** Using numbers, or choosing None, you can determine the order of the descriptions, and determine whether or not some might be left off altogether.

**Side:** Choose inside or outside of the arc.

**Order:** If you determine that the annotations are to be on the same row and same side of the curve, then you must pick the order in which they will appear, from left to right.

**Label Chord Angles in:** Bearing, azimuths or gons are the choices.

**Type of Curve:** Choose between Road and Rail.

**Flip Text on Arcs that Open to the North:** Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label:** The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Combine Common Radii:** This allows the user to reduce label clutter by minimizing labeling of connected arc segments that share a common radius and center point. When selected, only one radius label will be generated for such arc segments. The following shows an example where a curve made of three arc segments is labeled with only one radius label. The radius label is placed offset to the mid-point of the combined arcs.

[Image of Auto-annotate interface]

<table>
<thead>
<tr>
<th>Lines</th>
<th>Arcs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc Length:</td>
<td>A</td>
</tr>
<tr>
<td>Radius:</td>
<td>R</td>
</tr>
<tr>
<td>Delta Angle:</td>
<td>D</td>
</tr>
<tr>
<td>Chord Angle:</td>
<td>B</td>
</tr>
<tr>
<td>Chord Length:</td>
<td>C</td>
</tr>
<tr>
<td>Tangent:</td>
<td>T</td>
</tr>
<tr>
<td>Degree of Curve:</td>
<td>D0C</td>
</tr>
<tr>
<td>Extent:</td>
<td>E</td>
</tr>
</tbody>
</table>

**Chapter 3. Survey Module** 705
**Use Arc Tables:** Curve tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Curve Table Scaler" is enabled.

**To Curve Table Scaler:** The To Curve Table Scaler applies when the Type of Arc label options is not set to Curve Table. If the length of the arc is less than this minimum, the arc is labeled as a curve table entry. The To Curve Table Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches.

**Starting Table Number:** The Starting Table Number is the starting number for the first line entered in the Curve Table. Curve Table entries are numbered sequentially from the curve Starting Table Number. The location for Curve Tables can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current Curve Table. To set the location for the current Curve Table, run the Table Header command in the Annotate > Line/Curve Table menu.

**Stack Labels:** Stacked labels are sometimes preferred as they can help reduce label overlapping. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Stack Scaler" is enabled.

**To Stack Scaler:** When Stack Labels is set to "To Stack Scaler" this control is enabled. If the length of the arc is less than this minimum, the arc is labeled as a stacked label. The To Stack Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches. The Stack Settings button is enabled when Stack Labels is set to Always or By Scaler. This button brings up the Stack Arc Labels which displays the options for creating stacked arcs labels. The columns are described, followed by the rest of the options.
**Label:** Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row:** Using numbers, or choosing None, you can determine the order of the labels, and determine whether or not some might be left off altogether.

**Label Chord Angles in:** Bearing, azimuths or gons are the choices.

**Side:** Choose inside or outside of the arc.

**Type of Curve:** Choose between Road and Rail.

**Flip Text on Arcs that Open to the North:** Clicking here might make for an easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label:** The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Draw Leader for Stacked Labels:** When checked, a leader will be drawn from the stacked label to the mid-point of the arc.

**Stack Label Offset:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining arc.

**Align Text With Chord:** Determine whether the stacked label is oriented horizontally (unchecked) or in the direction of the chord (checked).

Auto-Annotation dialog commands, common to both Lines and Arcs.

**Apply Label Settings By Layer:** See the Label By Label Settings dialog and details below.

**Avoid Label Overlap:** See dialog and details below.

**General Settings:** Brings you to the Ate Defaults dialog.

**Layer Settings:** Apply Label Settings By Layer option must be clicked in order to activate. You will then see the Label By Layer Settings dialog.

**Overlap Settings:** Avoid Label Overlap option must be clicked in order to activate. Brings up the Avoid Label Overlap dialog.

**Reset to Defaults:** This returns you to the default label values.

**Load:** You can load an existing .AAN file.
We will now say, for example, that with linework only to label in the drawing we run this routine. We first decide
to go without the Avoid Label Overlap feature. This can be done by unclicking this option in the Auto-Annotate
dialog. We will say that there is a fence line cutting through our property line, the property lines being the lines that
we want to auto-annotate. In going without Auto Annotate’s overlap protection, we perform Auto Annotate and we
see that there is an overlap, with the labels running into the property lines and the fence line.

Panning and zooming the screen shows the problems we confront. Now, run Auto annotate again, but this time click
ON the Avoid Label Overlap feature. Then click Overlap Settings button which brings up a dialog as shown below.
This program and this specific dialog box has many different methods for fixing the overlaps. We will choose the
different methods to apply.

First, we will choose Slide. This slides the labels along the linework. We can even choose a maximum amount of
slide and other related parameters. We will also turn on the Stack method. The Avoid Linework Conflicts feature
pertains to that fence line we have. Finally, click OK. Now can pick the linework. Note that you do not need to
erase the existing auto annotate labels ahead of time. This command will remember that those labels were created
with this command. It will simply replace the entire group of labels with the new auto annotate labels.

The result, with overlap detection on, is that this routine fixed 7 out of 7 of the conflicts. It slid some of the labels
over and stacked others. You can also run Auto Annotate Overlap with manual mode. To do this, remove the
automatic options (such as Stack, Slide, etc.) and click View Remaining Overlaps After Applying Rules ON. Say
OK. It docks the Overlap Manager on the left side of the screen.

You can then fix the conflicts with this Overlap Manager by using the different methods presented in this new
window. This manager will highlights the conflicts, it will, for example, slide to the next conflict and allow you to
pick a new position. Hit the Next several times. Again, stack one, slide another over, and perform other changes.
Then choose Close.

Also, remember that depending on the linework layer, you can even have different annotation styles. There is also
an option to have different label settings "by layer". These decisions are made by using the Label By Layer Settings
dialog options. To get to this dialog, click on the Layer Settings button at the bottom of the Auto-Annotate dialog.

**Label By Layer Settings option and dialog.**

![Label By Layer Settings dialog](image)

**Layer:** Select a layer from the existing list of layers. If the linework you select and to be labeled is on this layer, the
parameters that you set in this dialog will be reflected in all labels.

**Auto-Annotation Settings:** Select an existing Annotation Settings file (AAN) by clicking the File button on the
right. Or stick with the defaults.

**Auto-Defaults Settings:** Select an existing Default Settings File (ADF) by clicking the File button on the right. Or
stick with the defaults.

**Load:** Select this option in order to load an existing layer file (LAY) to load.

**Avoid Label Overlap option and dialog.**
Overlap Settings dialog

**Available Methods:** Your choices. Pick from these.

**Used Methods:** Different ways in which this routine attempts to resolve the label overlaps. The overlap resolution attempt methods are applied in the order listed here.

**Slide:** If this is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

**Offset:** will move your labels perpendicular to your linework as far as you set the Max Offset.

**Table:** Replaces your labels with a numbers and create a table of the numbers with the corresponding labels.

**Reorient:** If chosen, the labels will change orientation in the plain view to avoid overlapping.

**Flip:** It will flip your label onto the other side of the linework.

**Stack:** It will stack or unstack the text of your labels to avoid overlapping.

**Move Area Labels:** This method, which only applies to area labels, will attempt to move the area label to the closest place within the area that doesn't overlap with any other labels. You can control the move interval (distance between move attempts) and total number of move attempts by setting the values "Interval (multiples of text height)" and "Max Move Attempts" in the "Move Area Labels Parameter" section:

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

**Add/Remove:** Some methods you might prefer not to use.

**Slide/Offset Parameter (multiples of text height):** These are variable that help you to slide or offset the label(s) in question.

**View Remaining Overlaps After Applying Rules:** This option will help you to see what still needs treatment.

**View Last Overlap File:** When it is checked, the Overlap Manager will return to the previous labels that were under review.

**Skip Resolved Overlaps:** When it is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

**Restore Original Zoom:** This will restore the zoom you were previously at before running the command.

**Avoid Linework Conflicts:** This is an extra precaution for when linework conflicts exist.
If there is a conflict, the following Overlap Manager dialog appears on the screen. It zooms to the conflict and provides you with the necessary tools to resolve the issues that need to be addressed. Many of the choices selected in the earlier dialog boxes can be modified yet again in the Overlap Manager, in your quest for a clean looking drawing. Within this special window you can zoom, pan, move to the next conflict, and perform many other tasks.

The **Overlap Manager** screen appears as a docked dialog window to the left of the main screen.

![Overlap Manager](image)

The Overlap Manager can be used to manually check and change label overlaps. The current overlap item will be have a yellow box drawn around it to help make it clear which item is the one currently being worked on. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels. When the current overlap item is an area label, only the Move and Table button will be enabled as these are the only two manual methods that can be applied to these types of labels. For line and curve labels, all methods will be enabled.

**Prompts**

**Auto Annotate Dialog** Choose settings and click OK.

**Select Lines, Arcs, and/or Polylines to Annotate.**

**Select Objects:** *pick entities*. Select the group of lines, arcs and/or polylines you want to annotate.

**Pulldown Menu Location:** Annotate

**Keyboard Command:** autoann

**Prerequisite:** Lines, arcs or polylines to annotate

**Custom Label Formatter AD**

This command allows you to customize the labeling for lines and polylines. You are first prompted to select a line or polyline to label, given the existing defaults currently set. The linework is shown as labeled on the screen. The
command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. In this dialog, there are three columns at the top of the dialog, along with other features. On the command line, there is also a choice called Format (F), which allows you to enter quick-key style keywords for quickly changing the label format. See below for these

![Custom Line Label dialog](image)

**Row:** This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected, then that item will not be displayed.

**Side:** This column allows you to place each item either inside or outside of the line or polyline.

**Order:** This column determines the order of items when they are placed in the same row.

**General Settings:** This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

**Reset To Defaults:** This button restores the default settings shown above.

**Load/Save:** You may also Load and Save different label configurations with the corresponding buttons.

### Prompts

**Options/Format/Points/<Select line or polyline>:** *select entity*

**Options/Format/Points/<Select line or polyline>:** O

**Custom Line Label dialog** choose your preferences and click OK

You can decide to go into the Option dialog at the start of the command, or after your initial labeling. If you use the Format command line option, you will be asked to enter the Format command. The choices are:

- **B** = bearing
- **A** = azimuth
- **G** = gon
- **D** = distance
- **R** = next row
- \_ = switch side of line

**Pulldown Menu Location:** Annotate > Angle/Distance

**Keyboard Command:** annline
Prerequisite: An arc to label

**Draw End Point Leaders**

These three commands draw a pair of leaders (crow's feet) at the ends of the line or polyline segment. The segment can be selected from a line, polyline or pair of points. The leaders are drawn above or below the line or polyline, or you can pick a side, depending on which Endpoint Leader command is run. The Pick Side command gives you the ability to place the crow's feet on a selected side of the line or polyline. Controls to customize the look of the endpoint leaders are accessed through the *Annotate Defaults* command in the Annotate menu. The Leader Size Scaler determines the maximum length of the leader. If the line segment is too short, the leader is shortened to fit. The actual length of the leader in drawing units is calculated by multiplying the leader scaler by the drawing horizontal scale (i.e., 0.5×40=20). The Offset Scaler sets the distance that the leader head is off the line endpoint. There are four leader styles to choose from: Arc with Arrow, Arc Only, Dash-Dot-Dash and Dashed. Endpoint leaders can be drawn together with bearing/distance annotation by having the Draw Leaders to Endpoints option on under *Annotate Defaults*. This Draw End Point Leaders command allows you to add the leaders as another step.

![Select Side Menu](image.png)

**Prompts**

**Define line by [Points/<select line or polyline>]:** *Select a line or polyline.*

If you wish to define by points, enter "P" at this prompt and pick points on the screen, or type in point numbers. If a coordinate (.CRD) file has not been previously loaded, a dialog will open to allow you to select a coordinate (.CRD) file to process. While using the Point selection method, the last point picked in the selection is stored in default brackets. So if you are working around a boundary, simply press enter to accept the defaults for the first point and move ahead to the next point.

![Arc with Arrow Endpoint Leader](image.png)

Arc with Arrow Endpoint Leader

![Dashed Endpoint Leader](image.png)

Dashed Endpoint Leader

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** crowft

**Prerequisite:** None

**Dynamic Annotation Note**

Bearing and distance annotations can be linked to the linework, such that the annotations will automatically update if the linework is changed. For example, if a line is moved with the AutoCAD *Move* command, the bearing label will update. This link can be found, and toggled on and off, under Object Linking in Configure > General Settings. Configure is in the Settings menu. The link is established between the label and the line, or polyline, when the label is created by commands such as *Auto Annotate, Line Table or Bearing Distance*. There are no links for annotation created using the Points option. To update bearing annotation without using the dynamic annotation, use the *Global Reannotate* command in the Annotate menu. To remove the links between the annotation and the linework entities,
use the *Remove Reactors* command, found under File > Drawing Utilities.

Fix Label Overlaps

This command allows you to fix label overlaps, where a conflict exists, for lines, arcs and polylines. You are immediately taken to the Avoid Label Overlap dialog. Here you can realign your labels by using a variety of optional methods. When the setting are to your liking, click OK. The command line then prompts you to select the entities for which to resolve annotation conflicts. Once you have selected your entities and hit Enter, this routine finds the conflicts and fixes the label overlaps.

If *Slide* is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

*Offset* will move your labels perpendicular to your linework as far as you set the Max Offset.
Table will replace your labels with a numbers and create a table of the numbers with the corresponding labels.

If Reorient is selected then the labels will change orientation in the plain view to avoid overlapping.

Flip will flip your label onto the other side of the linework.

Stack will stack or unstack the text of your labels to avoid overlapping.

Move Area Labels will attempt move overlapping area labels to the closest place to the original position that does not overlap with other labels. The distance between move attempts and the number of move attempts is controlled by the Interval and Max Move Attempts settings of the Move Area Labels Parameter section.

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

The Overlap Manager can be used to manually check and change label overlaps. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to step through and fix or ignore the unresolved labels. When the current overlap item is an area label, only table and move buttons will be enabled as these are the only methods that apply. For line and curve label overlaps, the buttons for all methods will be enabled. Once a label is moved with the "Move with Leader", only Table, Default and "Move with Leader" will be enabled. The Default button can be used to restore the label back to its original state.

When View Last Overlap File is checked, the Overlap Manager will return to the previous labels that were under review.

When Skip Resolved Overlaps is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

Restore Original Zoom will restore the zoom you were previously at before running the command.
Prompts

Select Lines, Arcs, and/or Polylines for which to resolve annotation conflicts:
Select objects: select entities

Pulldown Menu Location: Annotate
Keyboard Command: annconf
Prerequisite: Annotation conflicts

Switch Bearing/Azimuth Quadrant

This command switches the Bearing quadrant label or adds 180° to an Azimuth label. For example, N90°32'16"E would be replaced with S90°32'16"W or AZ 78°17'18" would be replaced with AZ 258°17'18". This routine changes bearing text to read as if the bearing were in the opposite direction.

Prompts

Pick Bearing or Azimuth Text: pick text
Pick Bearing or Azimuth Text: press Enter to end

Examples of switch bearing/azimuth quadrant
**Mirror Selected Labels**

This command rotates a group of text 180 degrees and maintains the same text position. Use this command to rotate any text. Ignores all entities in the selection set except text.

Before Mirror Labels

![Before Mirror Labels](image1)

After Mirror Labels

![After Mirror Labels](image2)

**Mirror and Flip Selected Labels**

This command mirrors the label to the other side of the labeled segment. At the new location, it then flips the label back to its original orientation. Use this command to manipulate any text. It ignores all entities in the selection set except text.

Before Mirror & Flip Labels

![Before Mirror & Flip Labels](image3)
After Mirror & Flip Labels

**Pulldown Menu Location:** Annotate > Flip Labels >
**Keyboard Command:** MFLIP_LABELS
**Prerequisite:** Text to rotate

---

### Flip Last Label

This command flips the last text drawn 180 degrees. Use this command to rotate your last annotation.

- **Pulldown Menu Location:** Annotate > Flip Labels
- **Keyboard Command:** flip
- **Prerequisite:** Text to flip

---

### Flip ON/OFF

When activated, the bearing and distance text will be rotated 180 degrees when drawn.

- **Pulldown Menu Location:** Annotate > Flip Labels
- **Keyboard Command:** flp
- **Prerequisite:** None

---

### Move Label with Leader

This command allows the user to make a leader label out of a selected angle/distance label.

**Prompts:**

- Select Label to Move (O for Options, R for Restore): pick an angle or distance label.
- Pick end point for move: pick the end point of the move (end of leader).
- Select another Label to Move (O for Options, R for Restore, Enter to End): pick another angle or distance label if desired.
Select Label to Move (O for Options, R for Restore): O

When Options is chosen the "Move Label With Leader Options" dialog allows the user to customize the leader and label drawing settings:
Minimum Leader Length Scaler: If the distance of the move is less than this value, a leader will not be drawn.

Draw Horizontal Leader Tick: When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.

Leader Offset Scaler: This is used to set the distance from the end of the leader and the annotation.

Use Separate Leader Layer: This allows the user to place the leader on a separate layer from the annotation.

Align Label to Linework: When selected the orientation of the label will be parallel to the linework. Otherwise the label is orientated horizontally.

NOTE: The leader scaler units (Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value, which was set in the auto annotation dialog.

Select Label to Move (O for Options,R for Restore): R
Select Label to Restore: pick an angle or distance label that had been moved with the "Move with Leader" command previously.
The selected label will be restored to its previous state.

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: amnlead
Prerequisite: Angle or distance label to move.

Bearing with Leader
This command places the bearing of a line or polyline segment at a point, then plots a user specified leader line to point to the defining line or polyline. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a point Select the point where to place the label.
Options/Points/<Select line or polyline>: O

Chapter 3. Survey Module
When Options (O) is chosen

**Pulldown Menu Location:** Annotate > Annotate with Leader  
**Keyboard Command:** brglead  
**Prerequisite:** None

---

### Distance with Leader

This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

**Define distance by, Points/Select line or polyline**: select a line  
**Pick point to start leader:** pick a point near the line  
**Label Position:** pick a point  
**Define distance by, Points/Select line or polyline**: press Enter to end

---

**Pulldown Menu Location:** Annotate > Annotate with Leader  
**Keyboard Command:** distlead  
**Prerequisite:** None

---

### Bearing-Distance with Leader

This command places the bearing and distance of a line or polyline at a point and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

**Options/Points/Select line or polyline**: select entity  
**Pick point to start leader:** pick a point near the entity  
**Label Position:** pick a point  
**Select the point where to place the label.**  
**Options/Points/Select line or polyline**: O
When Options (O) is chosen

**Pulldown Menu Location:** Annotate > Annotate with Leader  
**Keyboard Command:** bdlead  
**Prerequisite:** None

### Distance-Bearing with Leader

This command labels the distance and bearing of a line at the end of a user-specified leader which points to the defining line. The line can be specified by two points or by selecting a line or polyline entity. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

- **Options/Points/<Select line or polyline>:** select entity  
- **Pick point to start leader:** pick a point near the entity  
- **Label Position:** pick a point/Select the point where to place the label.

**Pulldown Menu Location:** Annotate > Annotate with Leader  
**Keyboard Command:** dblead  
**Prerequisite:** None

### Azimuth-Distance with Leader

This command places the azimuth and distance label of a line or polyline at a point, and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

- **Options/Points/<Select line or polyline>:** pick entity  
- **Pick point to start leader:** pick point  
- **Label Position:** pick location
Options/Points/<Select line or polyline>: O
Label Leader Settings dialog make selection

When Options (O) is chosen

Pull down Menu Location: Annotate > Annotate with Leader
Keyboard Command: azilead
Prerequisite: None

Flip Selected Labels
This command rotates a group of text 180 degrees. Use this command to rotate any text. The command ignores all entities in the selection set except text.

Pull down Menu Location: Annotate > Flip Labels
Keyboard Command: flip_labels
Prerequisite: Text to rotate

Global Reannotate
This command updates bearing and/or azimuth labels for when the lines and polylines associated with the labels have been rotated after the bearings and/or azimuths were labeled.

Prompts
Select One Bearing/Azimuth Text Before Rotation: pick a bearing or azimuth label
Pick line associated with old bearing/azimuth: *pick the line or polyline for the selected label*
Select All or specific objects to reannotate (<All/Objects)? *press Enter to update all text*

**Pulldown Menu Location:** Annotate
**Keyboard Command:** globalre
**Prerequisite:** Bearing or azimuth labels and lines or polylines

---

**Survey Text Defaults**

This dialog box routine sets up the defaults for the Building Dimensions, Offset Dimensions and Adjoiner Text commands.

![Survey Text Defaults dialog box](image)

**Building Dimensions** allows you to set text specifications for building dimensions.
- **Layer:** Allows you to set the layer for the building text.
- **Text Style:** Allows you to set the text style for the building text.
- **Text Size Scaler:** This value multiplied by the horizontal scale determines the actual text size.
- **Decimal Places:** Allows you to set the display precision for the building dimensions. The AutoCAD Units option sets the decimals to match the current drawing precision (LUPREC system variable).
- **Drop Trailing Zeros:** Allows you to truncate trailing zeros from dimensions.
- **Characters To Append:** Allows you to set characters to add to reported dimensions.
- **Offset From Line:** Allows you to set the offset distance from the line to the dimension text.

**Auto Label Closed Pline** allows you to choose between automatically labeling the Interior or Exterior or closed polylines. You may also choose none.

**Offset Dimension Text** allows you to set text specifications for offset dimensions.
- **Layer:** This option allows you to set the layer for the offset text.
- **Text Style:** This option allows you to set the text style for the offset text.
- **Text Size Scaler:** This value multiplied by the horizontal scale determines the actual text size.
- **Arrow Size Scaler:** This option allows you to set the arrow scaler to determine arrowhead size.
Decimal Places: This option allows you to set the precision for the offset dimensions. The AutoCAD Units option sets the decimals to match the current drawing precision (LUPREC system variable).

Drop Trailing Zeros: This option allows you to truncate trailing zeros from dimensions.

Label as Feet and Inches: This option allows you to use feet and inches.

Characters To Append: This option allows you to set characters to add to reported dimensions.

Offset From Line: This option allows you to set the offset distance from the line to the dimension text.

Text Alignment allows you to align text either parallel to the line or horizontally in the drawing.

Position allows you to determine if you are to pick the location of the text, or if the text is automatically positioned in the drawing.

Adjoiner Text allows you to set text specifications for adjoiner text.

Layer: Allows you to set the layer for the adjoiner text.

Text Style: Allows you to set the text style for the adjoiner text.

Text Size Scaler: Allows you to set the text scaler to determine text size.

Justification: Allows you to set the text justification. See the AutoCAD Reference Manual for details on each justification choice.

Dimension Line Type allows you to determine the line style to use for dimensions.

Single Arrow Line: Draws a line with an arrowhead from the dimension text to the figure.

Dual Arrows Line: Draws dual arrowhead.

Standard Line: Draws a line with no arrowhead from the dimension text to the figure.

Curved Leaders: Draws a curved line with an arrowhead from the dimension text to the figure.

Dimension Only: Draws the dimension text with no line.

Pulldown Menu Location: Annotate > Survey Text

Keyboard Command: svtextdf

Prerequisite: None

Offset Dimensions

This command labels the perpendicular distance between a point and a line or polyline. The point can be a building corner or other object. The endpoint snap is on by default for picking this point, although you may choose another snap mode manually. There is also an option for arrow only on end of line. The text layer, size, style and the dimensioning method are set in the Survey Text Defaults command, found in Settings > Configure > Survey Settings.

Prompts

[end on] Pick Bldg/Object Corner: pick a point

Pick Line To Offset From: pick a line or polyline
Offset Dimensions showing perpendicular distances from corners to property lines

**Pulldown Menu Location:** Annotate > Survey Text  
**Keyboard Command:** dimen txt  
**Prerequisite:** Line or polyline

### Building Dimensions

This command labels the length of line and polyline segments. The label is located in the middle of the line or polyline segment. The options for Building Dimensions are set in the *Survey Text Defaults* dialog. This dialog is found in Settings > Configure > Survey Settings. One option in *Survey Text Defaults* labels all the segments of a closed polyline with one pick of the polyline. Otherwise, the procedure is to pick a line or polyline segment and then choose an alignment. Depending where the alignment point is picked, the label is drawn either perpendicular or parallel, above or below the line.

**Prompts**

- **Pick Line or Polyline:** *pick line or polyline segment to label*  
- **Pick Alignment:** *pick point as shown*

**Pulldown Menu Location:** Annotate > Survey Text  
**Keyboard Command:** bldg txt  
**Prerequisite:** Line or polyline
Adjoiner Text

This command draws text that is aligned with the selected line or polyline segment. The layer, style, size and justification for the text is set in the Survey Text Defaults command, found in Settings > Configure > Survey Settings. To align text that is already drawn, use the Rotate Text command found in the Edit menu.

Prompts

Pick Line or Polyline: *pick a line or polyline for alignment*
Starting point: *pick a point to start the text*
Text: *MAIN STREET*

Adjoiner Text aligns text with a line or polyline

Pulldown Menu Location: Annotate > Survey Text
Keyboard Command: adjntext
Prerequisite: Line or polyline

Draw Grid

This command will plot a plan view grid at a user specified distance and optionally label the northing and easting coordinates of the grid. This command takes in consideration the current screen twist angle in which case it prompts for three corner points. After selecting the corner points the dialog below will appear. The title block is assumed right justified to the lower right corner of the grid definition points. After changing any of the settings select the OK button to plot the grid.
**Grid Interval:** The distance between each grid line.

**Horizontal Scale:** Reports the scale of the current drawing. This can also be set using the Drawing Setup command in the Settings menu.

**Grid Format:** The Ticks Only option will draw tick marks instead of grid lines. Selecting the Ticks Only option activates the Tick Size option for sizing the tick marks. There is also a Full Grid and Perimeter option.

**Layout of Ticks:** This option places the ticks throughout the interior of the grid work or just on the perimeter of the grid boundary.

**Use '-' for Negative Coordinates:** This option labels the negative grid coordinates with a '-'.

**Label Grid:** Selecting this Grid Text Setting option labels the grid coordinates.

**Use Split Coordinates Layout:** Puts the thousands digits above the grid line and the hundreds digits below the grid line.

**Text Size Scaler:** This scaler, multiplied by the Horizontal Scale, determines text size.

**Offset Scaler:** This scaler, multiplied by the Horizontal Scale, determines the offset for text.

**Avoid Title Block Area:** This Title Block Exclusion option will allow you to not draw grid lines or tick marks in the title block area. It is for making sure that the grid does not overwrite the title block.

**Pick Title Block Corner:** This option prompts you to pick the corner of the title block to determine where the grid lines and ticks will be omitted.

**X Dimension Scaler:** This is the horizontal dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.

**Y Dimension Scaler:** This is the vertical dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.

**Label Prefix North:** This option is for assigning a prefix to the northing grid line and tick mark coordinates.

**Label Prefix East:** This option is for assigning a prefix to the easting grid line and tick mark coordinates.

**Prompts**

**Pick or Type Lower Left Corner Point:** `endp of (pick point)`

**Pick or Type Upper Right Corner Point:** `endp of (pick point)` Select the corners of your border in which you want the grid plotted.

**Draw Plan View Grid Dialog**
Stack Label Arc

This command draws a small table of curve data. Unlike the command Label Arc, instead of fitting the text on the arc, this command lines the data up in rows. The command prompts to select an arc, define the arc by three points, or type O for Option to display the dialog shown here. For each type of arc value, you can specify the label and the sequence number. Under Label Options, the Stack Label Arc data table will display the values in the order by sequence number. There are also settings to justify label left or right.

Under Label Options, the data table will display the values in order based upon sequence number.

- **Arc Length**: Select a label prefix and a sequence number.
- **Radius**: Select a label prefix and a sequence number.
- **Delta Angle**: Select a label prefix and a sequence number.
- **Chord Angle**: Select a label prefix and a sequence number.
- **Chord Length**: Select a label prefix and a sequence number.
Tangent: Select a label prefix and a sequence number.
Degree of Curve: Select a label prefix and a sequence number.
External: Select a label prefix and a sequence number.
Radial Bearing-In/Out: Select a label prefix and a sequence number.
Label Chord Angles in allows you to set how the chord and radial angles are labeled as azimuth, bearing or gon.
Label Curve Angles in allows you to set how the delta angle and degree of curve are labeled as degree/minute/second or gon.
The Type of Curve option determines the type of curve.
Roadway: The length is determined as the true length of the curve.
Railroad: The length is adjusted based on 100-foot chord segments.
Flip Labels controls whether the text is drawn upside down in the current twist screen view.
The Use symbol for Delta Angle option uses a delta triangle symbol for the prefix.
Draw Leader Horizontal Tick draws a short horizontal line at the label end of the leader.
Align Text With Chord sets the angle of the text to match the chord angle. Otherwise, the text is draw horizontal to the current twist screen.
Justify sets the alignment for the text as left, center or right.

General Settings shows Annotation Defaults which has settings such as Text Size Scaler which apply to this routine.
Reset To Defaults puts the settings back to built-in defaults.
Load and Save functions store and recall the settings to an .ANS file. This is a way to share a label style with others or manage different styles.

Prompts

Options/Points/<Select arc>: P The P option causes the command to prompt for points on the arc. This can be useful for labeling sub-arcs such as lot corners of a cul-de-sac.
Pick point or point number for Endpoint of arc: pick a point
Pick point or point number for Radius: pick a point
Pick point or point number for Other Endpoint: pick a point
Direction of curve [Left/<Right>]? press Enter for right
Pick stack label point (Enter for none): pick a point
Pick point to start leader at ([Enter] for none): pick a point
To point: pick a point
Options/Points/<Select arc> (Enter to end): press Enter to end

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: slabarc
Prerequisite: an arc entity or arc points
Draw Legend

This command draws a legend based on a legend definition file. After choosing the legend definition (.LGD) file to use, a dialog displays the current definitions. The legend definition file consists of descriptions assigned to text, symbols, linetypes and hatch patterns. The default legend that is included with Carlson is called legend.lgd.

**Legend Definitions**

<table>
<thead>
<tr>
<th>Symbol name</th>
<th>Description</th>
<th>Include</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPT53</td>
<td>PINE TREES</td>
<td>No</td>
</tr>
<tr>
<td>SPT55</td>
<td>WATER METER</td>
<td>No</td>
</tr>
<tr>
<td>SPT59</td>
<td>BUSH &amp; SHRUBS</td>
<td>No</td>
</tr>
<tr>
<td>SPT64</td>
<td>CONCRETE MONUMENT FOUND</td>
<td>No</td>
</tr>
<tr>
<td>SPT65</td>
<td>ORCHARD TREES</td>
<td>No</td>
</tr>
<tr>
<td>SPT61</td>
<td>TREES</td>
<td>Yes</td>
</tr>
<tr>
<td>SPT63</td>
<td>GAS METER</td>
<td>No</td>
</tr>
<tr>
<td>LTYPE(BALL)</td>
<td>CURB</td>
<td>No</td>
</tr>
<tr>
<td>LTYPE(CURB)</td>
<td>WOOD POST FENCE</td>
<td>No</td>
</tr>
</tbody>
</table>

**Edit** edits a definition, select it and then click on the Edit button. This brings up the Symbol Definition dialog box.

**Legend Item**

- **Item Type:** Each item can be either a simple text label or a symbol from the drawing.
- **Text Name:** This is the legend label associated with the specified Description.
- **Symbol Name** designates the symbol to draw in the legend. You can either type in the symbol name or choose it from a slide library by picking the appropriate Select button.
- **Description** is the name of the symbol.
- The **Hatch Scale and Color** options are used if the symbol uses a hatch pattern.
- **Include in Legend:** This option corresponds to the Include column on the Legend Definitions dialog box. Not all the defined entries need to be drawn. An entry will be drawn (shown as Yes) if the Include in Legend box in the Symbol Definition dialog box is checked.
• **Select Point Symbol:** This option displays a slide library of point symbols to choose from.
• **Select Drawing Linetype:** This option displays a linetype name list to choose from.
• **Select Library Linetype:** This option displays a slide library of linetypes to choose from.
• **Select Hatch Pattern:** This option displays a slide library of hatch patterns to choose from.

**Add** inserts a new definition to the definitions. To insert a new definition, pick an existing definition and click on the Add button. The new definition is added immediately following the existing definition.

**Add from Drawing** adds entries to the legend table for each different symbol that is selected from the drawing.

**Remove** removes the selected definition.

**On** switches the Include field in the selected definition to Yes.

**Off** switches the Include field in the selected definition to No.

**On/Off by Drawing** prompts you to select symbols from the drawing. Symbols found will be turned on, all others will be turned off. This helps you create a legend that includes only symbols found in the drawing.

**Description by Field-to-Finish** uses the description from the Field-to-Finish code definition for symbols that match the code symbol.

**Sort** sorts the definitions alphabetically and numerically.

**Draw** draws the included definitions as a legend.

**Report** uses the Report Formatter to make a customized report of the names and descriptions in the legend.

**Move Up:** This option moves the selected definition up one row. Legend entries are drawn in the order that they are defined.

**Move Down** moves the selected definition down one row. Use the Move Up and Move Down buttons to change the order that the symbols will be drawn.

**Save** saves the legend file as its original file name.

**Save As** saves the legend file to a new file name.

**Exit** exits the command back to the drawing window.

**Draw** opens the Draw Legend dialog.

![Draw Legend Dialog](image)

- **Text Size** sizes the text in the legend. It defaults to the value from Drawing Setup in the Setting menu.
- **Symbol Size** defaults to the value from Drawing Setup in the Settings menu.
- **Hatch Size** sizes the hatch pattern scaler.
- **Line Size** sizes the lines in the legend.
- **Layer Name** defines the layer for the legend.
• **Draw Legend Title** draws the following text "Legend: These standard symbols will be found in the drawing."

### Prompts

**Specify Legend Definition File Dialog** *choose the file to process*

**Legend Definitions Dialog**

**Draw Legend Dialog**

Enter or pick upper left point for legend: *pick a point*

---

**LEGEND**

These standard symbols will be found in the drawing.

- ■ | True Roof
- — X | Property boundary
- — G | Gas line
- _______ | Liner
- ▴ | Right angle
- X | Corner Point
- ◊ | 15' Maple Tree
- △ | Forest

Sample legend created by Draw Legend

**Pull-down Menu Location:** Annotate

**Keyboard Command:** legend

**Prerequisite:** None

---

### Draw North Arrow

This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Library button which is similar to the Symbols Library command. The north arrow symbol library is stored in the narrow.dta file in the USER folder.

---

**Prompts**

**Draw North Arrow Dialog** *choose an arrow symbol, layer and other variables*

Specify insertion point: *pick a point*

X scale factor *<1> / Corner / XYZ:* press Enter

Y scale factor (default=X): *press Enter*
**Pulldown Menu Location:** Annotate  
**Keyboard Command:** narrow  
**Prerequisite:** None

### Draw Barscale
This command draws a barscale at the user-specified scale. The command options are set in the dialog shown here. The Horizontal Scale controls the size and labels for the barscale. For example, enter 50 for 1 inch = 50 feet in English mode. The Barscale Style chooses between different barscale formats.

### Prompts
Create Point Table
This command draws a table of the coordinate data of the points from the current coordinate (.CRD) file using different methods displayed at the top of the dialog. The command displays the dialog shown below for setting all of the point table options. At the top of the dialog enter the range of point numbers to label, do a Screen Pick or select a Point Group(s). You can also specify the order and format of the table columns. If you do not want to include a data type, set the Sequence number to blank.

Prompts

Point Table Generator Dialog
Building Data List ... Done.
Table Upper Left Corner: pick a point
Generating Table... Done.

Typical Point Table

<table>
<thead>
<tr>
<th>POINT</th>
<th>NORTHING</th>
<th>EASTING</th>
<th>ELEVATION</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>4837.185</td>
<td>4930.546</td>
<td>9.57</td>
<td>17</td>
</tr>
<tr>
<td>11</td>
<td>4814.573</td>
<td>4926.339</td>
<td>10.08</td>
<td>17</td>
</tr>
<tr>
<td>12</td>
<td>4780.075</td>
<td>4942.927</td>
<td>9.71</td>
<td>17</td>
</tr>
<tr>
<td>13</td>
<td>4720.636</td>
<td>4943.015</td>
<td>10.39</td>
<td>17</td>
</tr>
<tr>
<td>14</td>
<td>4672.472</td>
<td>4943.661</td>
<td>11.02</td>
<td>17</td>
</tr>
<tr>
<td>15</td>
<td>4640.627</td>
<td>4935.524</td>
<td>11.57</td>
<td>17</td>
</tr>
<tr>
<td>16</td>
<td>4608.962</td>
<td>4915.995</td>
<td>11.93</td>
<td>17</td>
</tr>
<tr>
<td>17</td>
<td>4577.485</td>
<td>4880.778</td>
<td>12.05</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>4504.513</td>
<td>4821.334</td>
<td>13.78</td>
<td>17</td>
</tr>
<tr>
<td>19</td>
<td>4436.527</td>
<td>4758.157</td>
<td>15.00</td>
<td>17</td>
</tr>
<tr>
<td>20</td>
<td>4370.285</td>
<td>4695.938</td>
<td>16.34</td>
<td>17</td>
</tr>
</tbody>
</table>

Chapter 3. Survey Module
**Update Point Table**

This command prompts you to select an existing point table. The program then reads the settings from this table and displays these settings in the same dialog used in *Create Point Table*. You can change any of the table format options. The program will also update the table to reflect any changes to the coordinate (.CRD) file.

**Prompts**

*Select existing point table:* pick anywhere on the point table or select points from the screen

**Point Table Generator Dialog**

**Pulldown Menu Location:** Annotate > Point Table

**Keyboard Command:** pointtblupd

**Prerequisite:** An existing point table, .CRD file

**Table Defaults**

This command sets the format for line and curve tables. Line and curve tables are commonly used in situations where:

1. The amount of line/curve annotation in the drawing itself makes the drawing look too "cluttered," and/or
2. The length(s) of the line(s)/curve(s) are too short for the annotation label being placed

You specify the label and table attributes in the Line/Curve Table Defaults dialog:

**Label Text Layer:** Click the Set button or specify the layer of the annotation which is applied to the line/curve itself.

**Label Text Style:** Click the Set button or specify the text style of the annotation which is applied to the line/curve itself.

**Label Text Size:** Specify the text size of the annotation which is applied to the line/curve itself.

**Line Label Prefix:** Specify a prefix which should be inserted prior to each line number. The prefix can be an alpha-numeric string.

**Line Table Title:** Specify a caption for the line table.

**Table Text Layer:** Click the Set button or specify the layer of the annotation which is inserted to the line/curve table.

**Table Text Style:** Click the Set button or specify the text style of the annotation which is inserted to the line/curve table.

**Table Text Size:** Specify the text size of the annotation which is inserted to the line/curve table.

**Row Height Factor:** Indicate a positive, non-zero multiplier of the Table Text Size to help adjust spacing for each row in the table.

**Curve Label Prefix:** Specify a prefix which should be inserted prior to each curve number. The prefix can be an alpha-numeric string.

**Curve Table Title:** Specify a caption for the curve table.

**Set Line Table Labels:** See the expanded Set Line Table Labels section below.

**Set Curve Table Labels:** See the expanded Set Curve Table Labels section below.
Prompt for Label Location: When enabled, this option prompts you to pick the location for the label placed onto the line/curve itself. If this is disabled, the location is chosen automatically.

Label Symbol: Select a geometric shape that is placed around the label that is applied to the line/curve itself.

Line Table Distance: Indicate how distances for the lines are reported:

- **Horizontal**: The distance displayed is only the horizontal distance, even if the selected entity has different "Z" values at either end of the line.
- **Slope**: The distance measured is the slope distance, used mostly for 3D polylines to get their true length.

Label Angles in: Indicate how the line direction is labeled:

- **Azimuth**: The angles are reported as azimuths.
- **Bearings**: The angles are reported as bearings.
- **Gons**: The angles are reported as gons.

Automatic Table Update: Indicate if labels in the table should be re-sequenced:

- **On**: This option renumbers the other table entries and the associated labels in the drawing if a new (but previously used number) is specified for the table. For example, if a line table contained lines #1-5 and a line #4 was added, the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6.
- **Off**: You must manually pick the entry location and update the labels.

Label Alignment: Indicate the method by which the label is oriented on the line/curve itself:

- **Horizontal**: This option places the label horizontal to the current screen alignment, as defined by the various *Twist Screen* commands (Standard, Line, Polyline or Text, Surveyor or Restore Due North).
- **Parallel**: This option will orient the label parallel to the line or curve chord.

Use Table Entity: When enabled, Line and Curve Tables can be further manipulated with the Split Table, Merge Tables and Edit Table Values commands.

Combine Equal Rows: When enabled, lines or curves that share identical geometry with other lines and curves can assume the number of the equivalent line/curve. As an example, if a line 100 feet long on a bearing of N 90°00'00'' E is assigned a label of L3 and additional lines with this geometry are labeled, you will have the option of re-using the L3 label for these additional lines. In other words, a single label reference in the table can correlate to many identical entities in the drawing and can keep the overall length of the line/curve table to a minimum.

Display First Row with Table Reference: When enabled, an additional reference item from the Line/Curve Table will be placed alongside the label number assigned to the line/curve itself.

Curve Options: Indicate the order in which curve labels shall be inserted into the curve table. Entries left blank (empty) will not be listed in the curve table.

Load: Loads a previously saved collection of Line/Curve Table Default values (*.LCT) into memory.

Save: Saves the current Line/Curve Table Default values to a *.LCT file.

Selecting the **Set Line Table Labels** option allows you to control the label, column width, text justification and displayed precision for the options selected in the Line Table Distance and Label Angles In controls.

With the above settings, you might find the Line Table more aesthetically pleasing as it produces the following example:
The prefix flexibility and the fact that the text used for the column header can be changed, means that line and curve tables can be plotted in any language. For example, in Puerto Rico survey plats are typically submitted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:

This would lead to the following line table (see the Notes section below for additional information):

Essentially identical to the *Set Line Table Labels* command, the **Set Curve Table Labels** command allows you to control the label, column width, text justification and displayed precision for the options selected in the Curve Options control.
Note:

- Changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command of Annotate Defaults.
- Reporting distance units in a unit of measure different from that of the current project is accomplished via the Drawing Setup → Report Distance Scale Factor option and the Annotate Defaults command.
- Physical changes to the lines/curves will trigger label updates if the Link Labels with Linework option (if available) is enabled under Carlson Configure → General Settings.

Pulldown Menu Location(s): Annotate → Line/Curve Table
Keyboard Command: tdef
Prerequisite: None

Table Header
This command draws the column header labels for the Curve Table and Line Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. The starting point location that the curve or line table command defaults to is one row below the start of the header labels.

```
CURVE  RADIUS  ARC LENGTH  CHORD LENGTH  CHORD AZIMUTH  DELTA ANGLE
```

Curve table header (C option)

Prompts

Type of table [Line/<Curve>]? C
Starting point of Curve table text <(6585.0 -704.0 0.0)>: pick point

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: tabhead
Prerequisite: None
Set Table Position

This command sets the position for adding line table entries. The next line table rows will start from this point. To add to an existing table, pick a point at the lower left of the existing table.

**Pulldown Menu Location:** Annotate > Line/Curve Table  
**Keyboard Command:** set_tbl  
**Prerequisite:** None

### Curve Table

This command will compute curve data and draw it in tabular form using the settings specified in *Table Defaults*. The program computes the curve data from an arc entity, an arc segment of a polyline or from specified points on an arc. The curve data includes radius, length of curve, chord length, chord bearing, tangent and delta or included angle. The current curve table numbers are remembered between drawings. The user is prompted for curve number (default is sequential starting with 1) and the starting point of the table. The curve is labeled with a C#, where # is the sequential curve number. After picking the starting point of the table, the placement point for the other table entries will default to the next position and you can just press Enter unless you want to relocate the table. The Auto Annotate command can also create curve tables. Use the *Table Header* command to draw the column header of the curve data names.

**Prompts**

Define arc by, Points/<Select arc or polyline>: *pick an arc*  
Enter curve number <1>: *press Enter*  
Starting point of curve table text <(5000,5000)>: *pick a point in a clear area of the drawing*  
Define arc by, Points/<Select arc or polyline>: *pick another arc*  
Enter curve number <2>: *press Enter*  
Starting point of curve table text <(4030,4490)>: *press Enter to use next position*  
Define arc by, Points/<Select arc or polyline>: *press Enter to end*

<table>
<thead>
<tr>
<th>C1</th>
<th>Radius</th>
<th>Arc Length</th>
<th>Chord Length</th>
<th>Chord Bearing</th>
<th>Delta Angle</th>
<th>Tangent</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>60.44</td>
<td>105.73</td>
<td>50.57</td>
<td>S 70°32.63’ W</td>
<td>3°54.14’</td>
<td>31.59</td>
</tr>
<tr>
<td>C2</td>
<td>137.62</td>
<td>79.59</td>
<td>74.99</td>
<td>N 71°29.44’ E</td>
<td>4°34.17’</td>
<td>39.99</td>
</tr>
<tr>
<td>C3</td>
<td>110.31</td>
<td>91.29</td>
<td>91.45</td>
<td>S 63°43.09’ E</td>
<td>48°18.35’</td>
<td>50.24</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Annotate > Line/Curve Table  
**Keyboard Command:** arctabl  
**Prerequisite:** None

### Line Table

This command will compute line data and draw it in tabular form, using the settings specified in *Table Defaults*. The program computes the bearing and distance from a line, polyline segment or between points. The current line table numbers are remembered between drawings. The line is labeled with a L#, where # is the sequential number of the line picked. The bearing and distance will then be drawn in tabular form similar to the previous Curve Table command. The Auto Annotate command can also create line tables. Use the *Table Header* command to draw the column header of the line data names.
Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: linetabl
Prerequisite: None

**Railroad Curve Table**
This command is exactly like Curve Table, except the curve data is calculated for Railroad curves. See the Curve Table command for more details.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: rr_curvetbl
Prerequisite: None

**Edit Table Properties**
This command allows the user to edit the properties of an entity based line or curve table.

**Prompts**

Select a line or curve table to modify: *pick an entity based line or curve table.*

If the table is not an entity based line or curve table the message "Error: You did not select an Entity based line or curve table." is displayed and control is returned to the previous prompt.

After picking an entity based line or curve table the Line/Curve Table Defaults dialog will be displayed. Here you can change the settings of the selected table. Change the settings for either line or curve tables depending upon the type of table selected. The changes will be reflected once the user selects the OK button.

Text Layer and Text Style determine the layer and style of the line/curve table text. The distance for line tables can be labeled in horizontal or slope distance. The Automatic Table Update option will automatically insert the entry into the line or curve table. The auto update will renumber the other table entries and the associated labels in the drawing. For example, if a line table had lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. Without the automatic update option, the entry location must be picked and the labels updated manually. The Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current twist screen and Parallel will draw the label parallel with the line or curve chord. The Line and Curve Label Prefix sets the text before the number that is drawn in the table and on the line or curve (i.e. "L3" or "Line3"). The Curve Options specifies which curve data to include in the table and the order. You specify the label and table attributes in the Line/Curve Table Defaults dialog.
Label Text Layer: determines the layer of the line/curve text.
Label Text Style: determines the style of the line/curve text.
Label Text Size: determines the size of the line/curve text.
Line Label Prefix: determines the prefix for each line.
Line Table Title: draws a title row at the top of the line table with this string.
Table Text Layer: determines the layer of the line/curve table text.
Table Text Style: determines the style of the line/curve table text.
Table Text Size: determines the size of the line/curve table text.
Curve Label Prefix: determines the prefix for each curve.
Curve Table Title: draws a title row at the top of the curve table with this string.
Prompt for Label Location: prompts you to pick the location to label each line or curve. If this is not selected, the location is chosen automatically.

Under Line Table Distance, the method for measuring distance is specified.
Horizontal: The distance measured is only horizontal, even if the line is a 3D polyline.
Slope: The distance measured is the slope distance, used mostly for 3D polylines to get their true length.

Under Label Angles in, the type of angle is selected.
Azimuths: The angles are reported as azimuth.
Bearings: The angles are reported as bearings.
Gons: The angles are reported as gons.

Under Automatic Table Update, the option automatically inserts the entry into the line or curve table. The auto update renumbers the other table entries and the associated labels in the drawing. For example, if a line table contained lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table, and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. If you set the Automatic Table Update to Off, you must manually pick the entry location and update the labels. If Automatic Table Update is set to On, the table is updated automatically whenever the line is modified.

Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current screen alignment, Parallel will draw the label parallel to the line or curve chord. Under Curve Options, you specify which curve data to include in the table and the order.
**Use Table Entity:** will use single block for the whole table. Otherwise, each row is a separate block.

**Combine Equal Rows:** will use the same line or curve number when the data exactly matches an existing row in the table. For example, if two line segments have the same bearing and distance, then they would both get the same line# (ie. “L5”).

**Display First Row With Table Reference:** When there is room on the line or arc, this option will label both the number and the first column data value from the table on the line or arc. For example, if the first curve table column is for radius and the arc length is big enough to fit the label, then the program would label both the curve # and the radius (ie. “C5 R=100.0”).

Selecting "Set Line Table Labels" will lead you to the Line Table controls, as "Set Curve Table Labels" (see graphic at end of this command page) leads to the Curve Table controls. For fields that apply to the Report Scale Factor from Drawing Setup, there is a second Scaled Label name for the table header. This scale factor can be used for reporting both grid and ground or both english and metric distances. The options in "Set Line Table Labels" are shown below:

![Line Table Labels](image)

With the above settings, for example, the Line Table appears as shown below. For improved "aesthetics", you might prefer to change the Bearing justification to "Center", for example.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18'48&quot; W</td>
<td>87.33'</td>
</tr>
<tr>
<td>L2</td>
<td>S 75°06'27&quot; E</td>
<td>148.57'</td>
</tr>
<tr>
<td>L3</td>
<td>N 88°27'07&quot; E</td>
<td>63.44'</td>
</tr>
<tr>
<td>L4</td>
<td>N 58°40'01&quot; W</td>
<td>63.44'</td>
</tr>
</tbody>
</table>

To save space, you can reduce the size of the "Distance" column from 11.5 to 10. Note that using the Line Label Prefix option, L1 and L2, for example, can read Line1 and Line2, and for that, you may want to expand the "Width" setting for the Line column. The prefix flexibility, and the fact that the text used for the column header can be changed, means that line tables and curve tables can be plotted in any language. In Puerto Rico, for example, surveys are typically conducted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:
This would lead to the following line table:

<table>
<thead>
<tr>
<th></th>
<th>LINEA</th>
<th>RUMBO</th>
<th>DISTANCIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18’48” W</td>
<td>87.33m</td>
<td></td>
</tr>
<tr>
<td>L2</td>
<td>N 88°27’03” E</td>
<td>63.44m</td>
<td></td>
</tr>
<tr>
<td>L3</td>
<td>N 58°40’01” W</td>
<td>63.44m</td>
<td></td>
</tr>
</tbody>
</table>

Note that changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command Annotation Defaults.

Finally, below we see the dialog that appears when you choose Set Curve Table Labels.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: tabedit
Prerequisite: An entity based line or curve table.
**Edit Table Values**

The **Edit Table Values** permits the modification of any of the text labels found within a Line or Curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults. This is commonly desired when subtle adjusts are desired on the content within a Line/Curve table.

Add: Adds a blank line to the end of the spreadsheet control.

Insert: Inserts a blank line immediately preceding the currently selected line in the spreadsheet control.

Delete: Removes the currently selected line from the spreadsheet control.

Report: Sends the current content of the spreadsheet control to the Standard Report Viewer.

Save As: Exports the current content of the spreadsheet control to an XLS file compatible with most spreadsheet applications, including Microsoft Excel (R).

Through the use of the Insert and Delete commands along with standard Windows Copy (Ctrl+C) and Paste (Ctrl+V) functionality, it is possible to return the list above into a normal-order list as illustrated below:

**Note:**

- Changes to the direction or length values **DO NOT** change the direction or length of the corresponding line or curve entity in the drawing!

**Prompts**

**Select an entity table to modify:** *Graphically select any portion of a table that is to be edited*
**Split Table**

The Split Table command allows you to break a Line or Curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults. This is commonly desired when a table is too lengthy to fit in its entirety on a plat. Splitting the table into two or more smaller tables allows the tables to be independently positioned on the plat. For example:

Becomes:

Note:

- In the example above, the initial table was first split at "L2" and then again at "L3".
Split tables can be re-assembled through the use of the Merge Tables command.

**Prompts**

**Select row of table to perform split on:** *Graphically select the last row of the table that is to be retained in the original table*

**Pull-down Menu Location(s):** Annotate → Line/Curve Table

**Keyboard Command:** splittbl

**Prerequisite:** A line or curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults

**Merge Tables**

The **Merge Tables** command allows you to combine two Line tables or two Curve tables into a single table. Both tables in the merge must have been created with the Use Table Entity option enabled under Line/Curve Table Defaults. For example:

![Diagram of merged tables]

Can become:
Note:

- In the example above, table "L1" was merged with table "L4" and then the modified "L1" table was merged with table "L3".
- Table numbers can be re-ordered through the use of the Edit Table Values command.

**Prompts**

**Select first table of merge**: Graphically select the first of two tables that should be combined together

**Select second table of merge**: Graphically select the second of two tables that should be combined together

**Pulldown Menu Location(s)**: Annotate → Line/Curve Table

**Keyboard Command**: splittbl

**Prerequisite**: Two or more line or curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults. Each table in the merge must contain the same number of columns as the other table.

**Delete Table Elements**

This command erases rows from line or curve tables. The table entries following the removed rows are automatically repositioned and renumbered. The line or curve labels on the linework in the drawing are also updated.

**Pulldown Menu Location**: Annotate > Line/Curve Table

**Keyboard Command**: del_tbl

**Prerequisite**: Line or curve tables

**Label Arc**

This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

**Prompts**
Define arc by, Points/<select arc or polyline>: select arc
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.

Examples of Label Arc (above and below)
Example of Stack Label Arc

**Pulldown Menu Location:** Annotate > Annotate Arc  
**Keyboard Command:** labarc  
**Prerequisite:** Arc or polyline should be drawn before execution

**Custom Label Formatter**
This command allows you to customize the labeling for arcs. You are first prompted to select an arc to label, given the existing defaults currently set. The arc is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. There are four columns at the top of the dialog along by other features.
Label: This first column allows you to set the prefix that will go before your arc data.
Row: This column allows you to stack the data in different ways. You can place more than one item in the same row. If None is selected then that item will not be displayed.
Side: This column allows you to place each item either inside or outside of the arc.
Order: This column determines the order of items when they are placed in the same row.
Flip Text on Arcs that Open to the North: When this is checked text will be orientated according to the open side of your arcs instead of being orientated according to the plain view.
Use Symbol for Delta Angle Label: Allows you to use the triangle symbol for delta as the label instead of plain alphabetic or numeric representation.
General Settings: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.
Reset To Defaults: This button restores the default settings shown above.
Load/Save: You may also Load and Save different label configurations with the corresponding buttons.

Prompts

Options/<Select arc>: select entity
Options/<Select arc>: O
Custom Arc Label dialog choose your preferences and click OK
You can decide to go into the Option dialog at the start of the command and after your initial labeling.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: annarc
Prerequisite: An arc to label

Draw Text On Arc
This command draws text that aligns with an arc or polyline arc segment. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc at that point. These text letters are automatically grouped together as an anonymous block. This command starts with the Create Text on Arc dialog. This command draws text that aligns with an arc, beginning at a picked point. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc. These text letters are automatically grouped together as a block. The text string, text height, and text style are set in the Create Text on Arc dialog box.

Text String: Specify the text to label on the arc.
Text Height: Specify the text height. The default value is obtained from the text height specified in Drawing Setup. The value set here is retained throughout the drawing session.
Text Style: Choose an existing text style from the list of defined styles.
Select text offset on screen: When checked, the program will prompt you for offset. You can set the text offset from the arc by graphically picking the offset point on the screen. When this option is not checked, the Text Offset field described below becomes available to specify a known offset distance.

Text Offset: If the above setting is not selected, specify the Text Offset here. A positive value denotes an offset distance inside the arc, while a negative value denotes an offset distance outside the arc.

Is base of text towards radius point?: This option determines whether the base of the text should face the radius point of the arc. It orients the text to the curve. Examples showing the results of different settings follow.

Example 1 - Offset distance specified on screen and base of text away from radius point.

Select Arc or Polyline segment: pick Arc or Polyline segment to place text on.
Select Text Offset: pick the desired offset distance from arc
Select Text Placement: pick a point, select the desired position to draw the text. Note that the text remains visible on the screen and attached to the "rubber banding cursor" so that various positions can be inspected before specifying the placement point. The graphic below shows this aspect of the command.

Note that the ghosted text is located along the mid point of the arc. If no offset distance is specified or picked from the screen, the text will be placed at this point. An offset of zero puts the text directly on the arc.

Example 2 - Offset distance specified in dialog and base of text towards radius point.

Select Arc or Polyline Arc Segment: pick Arc
Select Text Placement: pick point
Note that the prompt for offset distance was skipped because the offset distance was input on the dialog box. Simply select the text placement point resulting in the graphic below.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: textarc
Prerequisite: An arc entity

**Draw Text on Tangent**

This command is identical to *Draw Text on Arc*, except that the text is not curved to fit the arc. You are presented with this dialog box. Fill in the text, decide on the other options, click OK, and then follow the prompts.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: textarctan
Prerequisite: Arc or polyline arc segment
Edit Text on Arc or Tangent

This command allows you to edit text created by the Draw Text on Arc or Draw Text on Tangent command. You can change the text string, text height and text style. The program prompts you to select the Text on Arc entity, then displays the same dialog used in Draw Text on Arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: editarctext
Prerequisite: text entity as described above

Fit Text Inside Arc

This command fits text between two points picked along an arc. Text is curved to fit the arc using individual text entities, which can only be edited one at a time. The Draw Text on Arc command creates an text entity that can be edited using Edit Text on Arc or Tangent. It will optionally display information about the selected arc. If you choose to display the curve data, you will be prompted to pick the endpoints of the arc in a clockwise manner. When prompted, enter the text you want drawn inside the arc.

Prompts

Pick points in a clockwise direction.
[nea on] Start Point on arc for text: pick point on arc to start text Notice that the Nearest snap is turned on by default.
[nea on] End Point on arc for text: pick point on arc to end text Notice that the Nearest snap is turned on by default.
Enter text for inside of arc: MEADOWVIEW LANE

Fit Text Outside Arc

Same as the previous command except this command fits text on the outside of the arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: OARCT
Prerequisite: An arc entity

Change Polyline Linetype

This command changes the linetype of polylines or lines to the linetype selected from the dialog. True AutoCAD linetypes are created and applied to the selected entities, compared to other commands, such as Polyline to Special Line and Special Line/Entity, which break the polyline into segments. The spacing between linetype symbols and the symbols size are controlled by the Line Type Spacing and Symbol Size Scaler settings in the dialog. The Gap
Size Scaler controls the size of the break in the line for the linetypes that have a break like UserDef and Arrow_B. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end of the list of linetypes, there are two special choices. The UserDef choice lets you enter your own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.

**Prompts**

**Select Linetype dialog** select linetype and adjust other variables
**Select items to change.**
**Select objects:** pick the polylines
Linetype styles available using Change Polyline Linetype

**Pulldown Menu Location:** Annotate > Line Types

**Keyboard Command:** `pltype2`

**Prerequisite:** Polylines

---

**Polyline to Special Line**

This command converts polylines into special lines by adding the appropriate symbol onto the polyline, such as railroad, hedge, stonewall or telephone lines. Carlson has defined several line types as shown below. You can create custom lines by selecting the ? or another line type, which then prompts you for the text symbol to use. The size and spacing are set by the *Annotate Defaults* routine. This routine breaks the polyline in order to fit in the symbol. Broken polylines cannot be used by the *Area* command, and are difficult to edit. Consider using this command towards the end of your project.

*Change Polyline Linetype* command creates actual AutoCAD linetypes that are applied to the selected entities.
Prompts

Select Carlson Linetype dialog
Select the polyline(s) to convert.
Select objects: pick the polylines

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: pltype
Prerequisite: Polylines

Polyline to Tree Line
This command changes a polyline into a series of semicircles for representing a tree line.

Prompts

Side for arcs on polyline direction? (<Left>/Right) press Enter
Enter the segment distance <10.0>: press Enter
Select the polylines to convert.
Select objects: pick one or more polylines

Before and After Polyline to Tree Line

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: maketree
Prerequisite: Polyline
Add Zig to Polyline

This command draws a [not-to-scale] style zig to a polyline. First pick the polyline and then pick a position on the polyline to draw the zig.

Prompts

Zig size <4.0>: press Enter
Select polyline to add zig: pick a polyline
Pick or enter point to add zig: pick a point along the polyline
Select polyline to add zig: press Enter to end

Add Culvert to Polyline

This command adds culvert style brackets to both ends of the selected polylines.

Prompts

Culvert symbol size <4.0>: 12
Select polylines to add culvert symbols.
Select objects: pick the polylines

Sketch Tree Line

This command draws a tree line as you move the cursor. At the first prompt, you can type O for Options and set the Interval Scaler which controls the spacing of the bubbles. Also at the first prompt, you can type P for Polyline and then select an existing polyline to convert into a tree line. At the end, there is an option to flip the side for the bubbles in case they came out on the opposite side.
Special Line/Entity

This command breaks a line, arc or polyline and inserts a string of text or a block at an interval. It can be used to draw fence lines, utility lines, tree lines or any line which can be constructed by inserting a text or block entity. The command prompts to select an entity then the distance between inserts. Next, the user selects whether to insert text or a block, and whether to enter the distance or length to be broken out of the entity. If the user enters a 0 distance for the break distance, then the entity is not broken. If a distance greater than 0 is entered, then this distance is divided in half and broken out of the entity on both sides of the point at which the insert distance measures the entity.

If the user elects to insert text, the command prompts for the text to be inserted. Next, choose whether you want the text Middle or Center aligned, and whether you want to have the text flipped so it does not appear upside down. See the AutoCAD Reference Manual for more information on justification options. The size of the text is controlled by the text size setting in Drawing Setup.

If the user elects to insert a block, the command prompts for the block name. The size of the block is controlled by the symbol size setting in Drawing Setup. Considering that almost anything can be made into a block, such as raster images, wipeout entities, etc., this is a very powerful command.

Alternatives to this command are Polyline to Special Line and Change Polyline Linetype.

Guard Rail

This command adds box symbols along a polyline to generate a guard rail. See the command Change Polyline Linetype also.

Prompts

Pick First Point [Options/Polyline]: pick a point
Sketch treeline (pick point to end): slowly move the cursor and pick a second point to end the routine
Reverse direction [Yes/<No>]? press Enter

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: treeline
Prerequisite: None

Guard Rail

This command adds box symbols along a polyline to generate a guard rail. See the command Change Polyline Linetype also.

Prompts
Pick Polyline/Last: pick a polyline
Left/Right: L for Left
Pulldown Menu Location: Annotate > Line Types
Keyboard Command: grail
Prerequisite: Polyline

Label Angle
This command will label and report the interior, exterior and deflection angles between two directions. The angles can be defined by three points, or by two line or polyline segments that have a common endpoint. An example of labeling interior and exterior angles is shown below. The Both option will label interior and exterior angles simultaneously.

Prompts
Define angle by, Points/<select line or polyline>: pick a polyline segment
Select adjoining line or polyline: pick another polyline segment
Interior: 72d39'46" Exterior: 287d20'14"
Angle to label [<Interior>/Exterior/Both/Deflection/None]? press Enter
Typing B for Both labels both the interior and exterior angles.
Define angle by, Points/<select line or polyline>: press Enter to end

Label Coordinates/Elevation
This command will label a coordinate on the screen. You can choose to label the northing and easting, the Z elevation, or all three properties. The point can be picked on screen, or specified by point number from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label. Additionally, you can locate a label on Real Z Axis. The Label With Inches option labels with whole feet and inches for the decimal part. The Label Style chooses between labeling with a leader, with a symbol or along the x/y axis.
There is also an option to label the Delta X, Y and/or Z between two points, which is called Label Delta Between Two Points. When this option is clicked On, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If, for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.
The Save and Load buttons save and recall all the settings for this command to .LCE files. This is a way to manage different label styles for different mapping standards and to share between users.

**Prompts**

*Label Coordinates/Elevation dialog*

Point to Label?
Pick point or point number: *pick a point*
Point to Label (ENTER to End)?
Pick point or point number: *press Enter*

*Pulldown Menu Location:* Annotate  
*Keyboard Command:* labcoor  
*Prerequisite:* None

**Label LatLong**

This command will label the latitude and longitude of a selected point. The program will convert the northing and easting of the input points to latitude and longitude. The coordinate system for the drawing coordinates must be defined in Drawing Setup before running this command. First, the program displays a dialog box with options to set the label prefixes, to set the display precision, to draw a box around the label and to change the symbol used to mark the point. Then the program prompts for the points to label. As you move the cursor, the program display the latitude/longitude in real-time.

**Prompts**

*Label Latitude / Longitude dialog*

Pick point or point number: *pick a point*  
Pick point or point number: *press Enter to end*
Pulldown Menu Location: Annotate
Keyboard Command: lablat
Prerequisite: Define coordinate system in Drawing Setup

Label Curb Flow Elevations
This command labels top of curb and/or bottom of curb (flowline) elevations with a leader along an alignment. The data to label comes from Carlson points and alignment is defined by a selected polyline. The program reads all the points in the drawing and then you select which descriptions to use the top of curb labels and which to use for the bottom of curb labels.

There are separate settings for the top and bottom to control the label prefix, suffix and decimals. The Tolerance setting is the maximum distance between a point to label and the polyline. The Leader Bearing determines how the Leader Angle is applied: Relative adds the angle to the alignment polyline and Absolute means based on the orientation of the screen. The Text Horizontal Offset Scaler controls the distance between the alignment polyline and the label. The Text Vertical Offset Scaler controls the buffer offset between the leader line and the label. The User Leader Entities option chooses between drawing the leaders as polylines or as leader entities. The Elevate Annotations setting controls whether the labels are created at their elevation or at zero.
Prompts

Top Curb Descriptions pick descriptions to label for top of curb
Bottom Curb Descriptions pick descriptions to label for bottom of curb
Pick a polyline to annotate (Enter to End): pick a polyline
Pick side for flowline (Enter to End): pick a side

Pull-down Menu Location: Annotate
Keyboard Command: cfelev
Prerequisite: points with elevations and descriptions, and alignment polyline

Replot Descriptions

This command will create user specified text entities at the location of selected point descriptions.

Prompts

This command will Search for a certain Point Description and plot
New text on the current layer with current style.
Attribute Text to Search for <>: STK
New Text to plot <>: Stake Fnd
Select objects: Select Carlson points
Select objects: press Enter
Number of Text Entities Plotted: 4
Found four STK descriptions and created four text entities

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** plotdesc  
**Prerequisite:** Points with descriptions must be plotted. Set the layer and text style that you require.

---

**Textbox**  
This command allows you to draw a shaded, shadow text box around a selection of Text or Mtext. The size of the shading and the optional leader are determined by the height of the text that is selected.

---

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** textbox  
**Prerequisite:** Text or Mtext entities

---

**Label Offset Distances**  
This command labels the distances of a point to one or two lines. The first distance is between the point and an east-west line. This distance is labeled as either north or south of the line. The second distance is between the point and a north-south line. This distance is labeled as either east or west of the line. The distances are labeled with a leader and a description of the point.

**Prompts**

Pick 'E-W', Left to Right Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick 'N-S', Top to Bottom Property Line (if any)  
Pick Line or Polyline (Enter for None): pick the polyline  
Pick Offset Point, (N) for Number, <E> to Exit: pick a point  
Pick point to start leader at: pick a point at or near the offset point
To point: pick an alignment point for the label
To point: press Enter
Pick Offset Point, (N) for Number, <E> to Exit: press Enter to End

Pulldown Menu Location: Annotate
Keyboard Command: offlab
Prerequisite: Polyline or Line
Current Information

The Current Information Dialog Box contains information on:
Drawing: displays the current drawing file Path, Name, Scale, and Units
Coordinate File: displays the current coordinate file path and names.

File Type: This will display the current Coordinate file type.
The file types are:
C&G Numeric (.CRD) (PT #: 126)
C&G Alpha-Numeric (.CGC) (PT #: RW126)
Carlson Numeric (.CRD) (PT #: 126)
Carlson Aloha-Numeric (.CRD) (PT #: RW126)

Description Length: Numbers of character in the description
Total Points: Total number of points in the file
High Point: The highest point number stored
Points Used and Points Available: displays the block or blocks of points used or available in the coordinate file currently open.
Other Files: Displays the files that are currently open:
Data Path: displays the current default path and coordinate file name
Description Table: displays the current default path and description table
Print: displays the current default path and Print file name
Raw: displays the current default path and RAW file name
Map Check: displays the current default path and Map Check file name
Cross Section: displays the current default path and Cross Section file name
TIN: displays the current default path and TIN file name

Pulldown menu Location: CG-Survey > File
Keyboard Command: INF, cg_current_info
Coordinate Files

Opening Closing and Saving

Choose Coordinate Files from the CGFile pull-down menu.

New

The New allows you to create a new coordinate file.

Prompts

Follow these steps: CGFile > Coordinate Files > New Coordinate File
Save in: Browse to folder location

Enter the name of the coordinate file you wish to create: File Name: Hickory farms

Press enter or press Save Button

NOTE: The directory displayed is the Data Path is the directory as set from the tool bar:
CG-Tools > CG Options > Data Path Options

NOTE: The description length for the new file just created will be set based on the current description length setting in the:
CG-Tools > CG Options > General

NOTE: You will not be able to change the description length once the new file is created. You must set the description length prior to creating the new file. You can however move the points to another file that has a longer description length

Pulldown Menu Location: CG-Survey > File > Coordinate Files
Keyboard Command: OPNC, CG.NEW.COORD
Prerequisite: None

Open

The Open menu item allows you to open an existing .CRD or .CGC file. Only one coordinate file can be open at a time in a given drawing.

Prompts

To open an existing coordinate file follow these steps:

In the file dialog box (Shown below),
Browse to folder location
select or Highlight the coordinate file you wish to open by clicking on it
Click the Open button

NOTE: The default directory is the "Data" directory below the directory where CG-SURVEY was installed. You can change the default directory by choosing:
CG-Survey > Tools > CG Options... - Data Path tab.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files
**Keyboard Command:** OPC, CG_OPENCOORD
**Prerequisite:** an existing coordinate file

**Close**
To close an open coordinate file

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files
**Keyboard Command:** OPC, CG_OPENCOORD
**Prerequisite:** Coordinate File Open

**Save As**
As new points are stored in a coordinate file, the file is automatically updated. If you are concerned that the changes to be made to the coordinate file may not be correct, you should use the Save As option to make an extra copy of the file before making any changes. This option allows you to save the open coordinate file under a different name. The new file becomes the current file. The original file will remain unchanged.

**Prompts**
To Save As the open coordinate file under a new name, select: > CGFile > Coordinate File > Save As

**Browse to Folder Location:** The Save Coordinate File As dialog box will display the default directory as set in the Data Path Options,

**Enter the name:** of the new file for the coordinates to be saved to.

**Press Save Button:** Save or Press enter

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files

**Keyboard Command:** SCF, CG_FILE_SAVEAS

**Prerequisite:** None

---

**Export Coordinates to ASCII**

This menu item allows you to export coordinate files to an ACSII (American Standard Code for Information Interchange) file format. ASCII files are a simple text format and can be read by almost all word processors and text editors.

**Prompts**

**To export coordinates to an ASCII file, follow these steps:** > CGFile > Coordinate File > Export Coordinates to ASCII File
If a coordinate file is not currently open, the Open Coordinate File dialogue box will appear, select the file.

You will be prompted at the command line to select the points you wish to export:
Add points from coordinate file. (Enter When Done) (All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select):
After choosing the set or sets of points you wish to export, press until the following dialogue box appears.
Enter a new file name or select an existing ASCII file and click the Save button. Next, select an ASCII file format (see the ASCII File Formats section of this chapter for an explanation of each format):

```
STANDARD (Point #, North, East, Elevation,"Desc")
2.5054.76393,9777.75761,103.70000,"gs"
3.5098.69743,9783.82411,105.20000,"gs"
4.5158.78043,9773.74111,105.67000,"gs"
5.5205.11493,9777.40661,106.25000,"gs"

CLM (PNT Point # Easting Northing)
PNT 2 9777.75761 5054.76393
PNT 3 9783.82411 5098.69743
PNT 4 9773.74111 5158.78043
PNT 5 9777.40661 5205.11493

Autocogo (Point # Easting Northing Elevation Desc)
```

Select the OK button to export your coordinate points.

**ASCII FILE CONVERSION FORMATS**

NOTE: In the following formats the point code can be placed in the first two characters of the description field, followed by a semicolon. The description will follow the semicolon. You can export and import ASCII files in the following formats:

STANDARD (Point #, North, East, Elevation,"Desc")
CLM (PNT Point # Easting Northing)
Autocogo (Point # Easting Northing Elevation Desc)
MTI (Point #, Easting, Northing, Elevation,"Desc")
2,9777.75761,5054.76393,103.70000,gs
3,9783.82411,5098.69743,105.20000,gs
4,9773.74111,5158.78043,105.67000,gs
5,9777.40661,5205.11493,106.25000,gs

Standard (without description quotes) (Point #, North, East, Elevation, Desc)
2,5054.76393,9777.75761,103.70000,gs
3,5098.69743,9783.82411,105.20000,gs
4,5158.78043,9773.74111,105.67000,gs
5,5205.11493,9777.40661,106.25000,gs

Abacus/MTI (Point #, Northing, Easting, Elevation)
2,5054.76393,9777.75761,103.70000,12;gs
3,5098.69743,9783.82411,105.20000,12;gs
4,5158.78043,9773.74111,105.67000,12;gs
5,5205.11493,9777.40661,106.25000,12;gs

Surv-A-Soft (Code Northing Easting: Desc/Elevation")
6 0 "VER 2"
   -1 0.00000 0.00000 " "
   2 5054.76393 9777.75761 "103.70000"
   2 5098.69743 9783.82411 "105.20000"
   2 5158.78043 9773.74111 "105.67000"
   2 5205.11493 9777.40661 "106.25000"
   2 5253.39243 9779.12911 "110.47000"

The Surv-A-Soft file structure is as follows:
The first line of the file is a header line with the following information:
The total number of points is placed in the code field.
Zero (0) is placed in the northing field.
"VER 2", etc. is placed in the easting field.

After the header line each line specifies a coordinate point. The line number minus one is the point number.
The code field has three possible values:

Value Explanation
-1 no coordinate point
2 elevation (in description field)
1 description (in the description field)

Since .CRD and .CGC files can have both an elevation and description, when converting them to an ASCII
Surv-A-Soft file one of the following will occur depending on the elevation value:

If the point has an elevation it will be placed in the description field. If there is no elevation, the description
will be placed in the description field.

Star*Net (Point # Northing Easting Elevation Desc)
2 5054.76393 9777.75761 103.70000, gs

Chapter 4. CGSurvey Module
USER DEFINED

Upon selecting User Defined format, the following dialog box will appear:

As the name implies you can create a format specific to your conversion needs.

Creating a User Defined Format: There are 5 basic pieces of information that can be defined in a user defined format. Point number Northing (required) Easting (required) Elevation Description (Code can also be part of the description field) There are two types of user defined formats " Character Separated Fields Character Separated Fields means that each field of information is separated by a character, often times a comma, but any ASCII character can be used. Fixed length Fields Fixed length fields means that you define the number characters for each field item. The fields can be in any order

Field Order
Point Number 4
North 3 (required)
East 2 (required)
Elevation 1
Description 5

NOTE: Coordinate values will be rounded based on the setting in the Rounding Options dialog box. If the point number field is not assigned a value, the line number will be the point number. Select the Field Type (Character Separated or Fixed Length) and follow the appropriate instructions below:
Character Separated User Define Export File

> Go to CGFile > Select Coordinate files > Select Export to ASCII At the command line you will be prompted to select points: Add points from coordinate file. (Enter when Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select): After selecting the point set or sets to export press return

Select or name the file to store the converted points.

Set the conversion format to "User Defined Format" The following dialog box allows you to define the attributes of the points being converted.
For this example Character Separated Fields has been chosen as the Field Type.
Points........... -> 1
North.......... -> 2
East............ -> 3
Elevation..... -> 4
Description -> 5
So the line data will be: Point #, North, East, Elevation, Description

**Empty Field Values:** It's necessary to distinguish between a field that has no value and a field that has "0" as a value. In coastal areas "0" is a valued elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be misunderstood for a valid value, a conversion process will not produce invalid data.

**Character Values:**

1st & 2nd Field Separators, these are the ASCII characters that define the fields within a line.
1st & 2nd Line Terminator; these are the ASCII characters that define separate lines
Description Markers; An ASCII character that surrounds the description such as quotation marks.
Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:

1st Field Separator: 44 (which is a comma)
2nd Field Separator: -1 (none used)
1st Line Terminator: 13 (carriage return)
2nd line Terminator: 10 (line feed)
Description Marker: -1 (none used) Code Separator: -1 (none used)

This example would read as follows: 1,5000.0000,10000.0000,954.63,MH
The following is a list of all of the ASCII codes and the respective values.
2nd Field Separator: You may however define two separators. For example, you can use a carriage return and line feed if you wish to have each field on its own line: 1 <CR> <LF> (Point number)
1000.000 <CR> <LF> (Northing)
1000.000 <CR> <LF> (Easting)
954.56 <CR> <LF> (Elevation)
MH <CR> <CF> (Description)

NOTE: Do not use a character as a separator if it appears in any of the fields. For example, if your record looks like this:
1 1000.000 1000.000 954.56 MH <CR> <LF>

Then the period (.) character cannot be used as a separator because it is used in the northing, easting and elevation fields. Pressing the View ASCII Codes button will show you the 256 valid characters that can be used in an ASCII file. The table shows each character, with its integer value to the left of it.

NOTE: Character number 26 cannot be used as a field separate because it marks the End of File (EOF).

Fixed Length Field User Define Export File:

>Go to CGFile >Select Coordinate files
>Select Export to ASCII Select points. (Enter When Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):

At the command line you will be prompted to Select Points After selecting the point set or sets to export press return Select or name the file to store the converted points.
Set the conversion format to "User Defined Format"

The dialog box below allows you to define the attributes of the points being converted.

For this example Fixed Length Fields has been chosen. In this case the order is set at:
Points......... - > 1
North......... - > 2
East......... - > 3
Elevation..... - > 4
Description - > 5

So the line data will be:

**Point #** - North-East-Elevation-Description But unlike Character Separated Fields, the information sets will be defined by their placement on the text line, rather than a separating character.

**Empty Field Values:** It is necessary to distinguish between a field that has no value and a field that has "0" as a value. In many cases around coast lines "0" is a contour elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be misunderstood for a valid value, any conversion process will not produce questionable data.

**Character Values:** 1st & 2nd Field Separators, do not apply, separators are defined by spacing.

1st & 2nd Line Terminator; do not apply, separators are defined by spacing.

Description Markers; An ASCII character that surrounds the description such as quotation marks.

Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:

1st Field Separator: Do not apply
2nd Field Separator: Do not apply
1st Line Terminator: 13 (carriage return)
2nd line Terminator: 10 (line feed)
Description Marker: -1 (none used)
Code Separator: -1 (none used)

This example would read as follows:

1 5000.0000 10000.0000 954.63 MH <CR> <LF>

The first 8 spaces are the reserved for the point number The next 16 are reserved for the northing The next 16 are reserved for the easting The next 16 are reserved for the elevation The next 20 are reserved for the description Then a (carriage return) and a (line feed)

**The following is a list of all of the ASCII codes and the respective values.**
NOTE: Do not use a character as a separator if it appears in any of the fields.

Description Markers: If you have a description field, you may wish to use a Description Marker. This is a character that surrounds the description. For example, a description surrounded by quotes: 23,1056.789,2345.769,982.345,"MH" <CR> <LF>

If you are not using a description marker, enter -1 in the Description Marker box.

Code Separator: If you have a description field, and want the first characters of the description field to be a C&G point code, you can enter the decimal value of the character that separates the point code from the description. This allows you to transfer both the point code and the description to an ASCII file. For example, using a semicolon as a code separator: 23,1056.789,2345.769,982.345,"MH; Inv Elev -9.23" <CR> <LF>

If you are not using a code separator, enter -1 in the Code Separator box.

No Northing Value and No Easting Value

If the ASCII file does not have a point number field, the No Northing and No Easting values are mandatory. The record number will be used as the point number. This means that skipped point numbers will be filled with false northing, easting and elevation values.

Here is an example of a file with a record that has no point number field (assume you entered -999999 in the No Northing, No Easting and No Elevation boxes):
1056.789,2345.769,982.345,MH <CR> <LF> Point 1
-999999,-999999,-999999,<CR><LF> No Point 2
2356.679,2455.645,992.678,MH <CR> <LF> Point 3
2786.799,5645.789,984.234,MH <CR> <LF> Point 4

No Elevation Value You must place a value in this box. When converting a C&G point to an ASCII point, this value will be placed in the elevation field of the ASCII point if a C&G point with "No Elevation" is encountered. When converting an ASCII point to a C&G point, if "No Elevation" is encountered in the ASCII point then "No Elevation" will be placed in the elevation field of the C&G Point.
Import ASCII File into Coordinates

This option allows you to import the contents of an ASCII file into a coordinate file.

Prompts

Follow these steps: > CGFile > Coordinate Files > Import ASCII File Into Coordinates

If a coordinate file is already open, the ASCII file will be imported into it, if a coordinate file is not open you will be prompted to open an existing file or create a new coordinate file.

Select the ASCII format that is being imported and how to handle duplicate points.
The points will be imported and displayed on the screen.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files  
**Keyboard Command:** IMC, CG_IMPORT_COORDS  
**Prerequisite:** None

---

**Close Raw File**

To close the current raw data file, select CGFile from the main menu and then select Close RAW File.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** CLR, CG_CLOSE_RAW  
**Prerequisite:** Raw File OPEN

---

**Close Map Check File**

To close the current map check file, select CGFile from the main menu and then select Close Map Check File.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** CLM, CG_CLOSE_MAP  
**Prerequisite:** Mapcheck file Open

---

**CGDos Drawings**

Before opening a CGDOS drawing you must choose the "setup" option to provide information needed for opening the PL!/PL2 files.
This feature allows you to import a CGDOS PL1/PL2 file and convert it to a standard CAD drawing. This is similar to a DXF conversion, but in addition to simple converting the graphics, this feature also retains the C&G data. That means that after the conversion is finished the drawing file is still referenced to the coordinate file. If you query a line it tells you what coordinate file the graphic was created from, the points that line is drawn from, the layer and line stop information just like query did in the CGDOS. This means you can continue working on the job after the conversion in a manner that is familiar to you as it was in CGDOS.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** None  
**Prerequisite:** CGDos Drawings>Setup

### Open Dos Drawing

If the current drawing file you are in has any graphics the following dialog box will appear. This is meant to prevent you accidentally placing the PL1 drawing on top of another existing drawing file.

![Open Dos Drawing Dialog Box](image)

Selecting will bring up the following dialog box that will allow you to select the PL1 file to be converted to a standard CAD drawing.

![Select PL1 File](image)
After selecting the file to be converted, if you look at the command line you will see that the program is going through the PL1 file and converting the drawing entities one at a time to make them conform to the C&G format. This means all of the C&G data is maintained so the new drawing is still linked to the coordinate file it was created from. Also during this conversion process any of the CGDOS *.INS files (inserts) will be converted to standard CAD blocks and be added to the CG list of available inserts. Meaning all of the inserts you were accustomed to using in the CGDOS product will now be a part of the CG Survey program.

**Prompts**

*Select a *.PL1 drawing file from browse file dialog box:* Select file & click on OPEN button

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** None  
**Prerequisite:** CG-Survey > File > CGDos Drawings>Setup completed properly

**Setup DOS Dwg**

The first dialog asks you to give the path to the CGDOS Program Files and the path to CGDOS Inserts.

![Setup C&G DOS Drawing conversion dialog](image)

When this is set properly, any Insert used in the DOS PL1 file will be converted to a block and stored in the C&G symbols folder: These inserts will also be listed in the insert library when you go to: CGDraw > Drawing Settings > Active Symbol NOTE: Currently those inserts converted from the CGDOS PL1 files will not be shown graphically in the CGSurvey Active Point Symbol dialog box but they will appear in the symbols list and thus can be selected for use from the list.

**Prompts**

*Select a Location for CGsurvey Program from browse file dialog box:* Pick Browse button  
*Select a Location for Insert files from browse file dialog box:* Pick Browse button

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** None  
**Prerequisite:** None
Convert Old CG Dos Level File to New Format
This option converts old C&G DOS level files (files with a .LEV extension) to the new CGSurvey level file format (files with a .LEV extension).

**Prompts**

Select CGFile from the main menu.
Select Convert Old C&G DOS Level File to new Format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

**Pulldown Menu Location:** CG-Survey > File
**Keyboard Command:** CVL, CG_CONVERT_DOS_LEVEL_FILE
**Prerequisite:** None

Convert Old CG Dos Raw File to New Format
This option converts old C&G DOS raw files (files with a .RAW extension) to the new CGSurvey raw file format (files with a .CGR extension).

**Prompts**

Select CGFile from the menu bar.
Select Convert old C&G Raw File to new format from the pull-down menu.
From the file dialogue box, select the file to convert:
Click the OPEN button to convert the file.

**Pulldown Menu Location:** CGFILE
**Keyboard Command:** CVR, *CG_CONVERT_RAW
**Prerequisite:** None

Convert Old CG Dos Cross Section File to New Format
This option converts old C&G DOS Cross Section files (files with a .EW extension) to the new CGSurvey earthwork files format (files with a .CEW extension).

**Prompts**

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert: Click the OPEN button to convert the file.

**Pulldown Menu Location:** CG-Survey > File
**Keyboard Command:** CVX, CG_EW_CONVERT_FILE
**Prerequisite:** None
Convert Old CG Dos Template File to New Format

This option converts old C&G DOS Template files (files with a .TPL extension) to the new CGSurvey earthwork files format (files with a .CTP extension).

Prompts

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

Pullldown Menu Location: CG-Survey > File
Keyboard Command: CVT, CG_EW_CONVERT_TEMPS
Prerequisite: None

Empty Print File

Choosing this menu item will remove all the text now in your print file.
You should empty the print file periodically so that it does not use too much of your disk space and become difficult to view and print.

Note: If user wishes to change the Printer.Txt file name or choose a different location. see CG-Survey > CG Options... - Output Tab

Pullldown menu Location: CG-Survey > File
Keyboard Command:EPF, cg_df
Prerequisite: Set print file name and path in CG-Survey > CG Options... - Output Tab

Print View Print File

While computations are taking place a Print File is being maintained showing all computations. This file is saved in the text file specified in the Output Options dialog box below

This text file may be edited, printed or viewed from any text editor or any word processor. (Note: For further explanation on Output Printing Settings please consult CGTools Menu)

After choosing the Print/View Print File menu item, the print file will be opened using the Windows text editor WordPad. To print the whole file, use the printer icon or the Print menu item on the WordPad File menu. To print a portion of the print file, you must highlight the portion you wish to print, then choose File > Print. On the General tab of the Print dialog box click the Selection radio button then click the Print button to print the highlighted text.
You can choose whether to use the Windows Notepad or Wordpad to view and print the print file by going to the CG-Survey > CG Options... menu and clicking the Output tab then clicking on either the Notepad or Wordpad radio buttons in the Print File Viewer section of the dialog (shown below).

NOTE: You can also use Pull Down menu Location: CG-Survey > File.

Keyboard Command: VPF, CG_VIEW_PRINT_FILE

Prerequisite: Set print file name and path in CG-Survey > CGOptions... - Output Tab

CGTrav

Quick Traverse

This feature allows you to utilize the keyboard and the mouse to perform a traverse using points and data found in the drawing and the coordinate file. There is no raw data entry associated with Quick Traverse. The Quick Traverse feature has no ability to adjust the resulting traverse. If you wish to adjust coordinates, you could create a raw data file using the CGEditor - on the CGTrav menu - then use the Reduce Traverse feature, also on the CGTrav menu.

NOTE: If you wish to check the closure of a plat from bearing and distance data, use the CGEditor to create a map check file, then use the Reduce Map Check File feature on the CGTrav menu.

Prompts

During the process of entering data for the Quick Traverse feature you will see the prompt:

[aZimuth/Bearing/Deflection/Side shot/cUrve/Closure/horiz. distaNces]

At this prompt you may:

- Change the type of angular input between Horizontal Angle, Azimuth and Bearing modes at any time.
- Change how distances are specified as either slope distance and vertical angle or horizontal distance and vertical distance.
- Turn the vertical angle input on or off.
- Traverse around tangent and non-tangent curves.
- Switch from Traverse to Side shot mode.

Traverse mode: automatically occupy the foresight point.

Side shot mode: continue to occupy the current instrument point until you change to Traverse mode: and thus occupy another point.

Note: There are several settings found in the C&G Options dialog box that should be set or checked prior using the Quick Traverse feature:

The default values for the initial traverse input modes are set in the Traverse Options.
If you wish to calculate or enter elevations, check the Elevations: ON checkbox and choose Enter Elev. Or Calculate Elev. as desired in the Global Options tab. If you are calculating elevations, make sure the Vertical Angles ON checkbox is checked on the Traverse Options tab.

Quick Traverse Example

In this example the mode is set to traverse and elevations are on and are to be calculated.

After choosing Quick Traverse from the CGTrav menu you will be asked to enter the following information:

Instrument point: for the example enter 1 (assuming that the currently open coordinate file has a point in it with a point ID of 1).
Backsight point: for the example enter 2.

Since elevations are on and set to calculate so you will be prompted for the following:
If you selected H.I. as Plus-Up on the Traverse Options tab, the coordinates and elevation of the instrument point will be read from the file and you will be prompted for the instrument height (H.I).
If no elevation is found, you will be prompted to enter the ground elevation at the instrument point and then the H.I.
If you selected H.I. as Elevation in the Traverse Options dialog box, you will be asked to enter the actual elevation of the instrument scope.

Backsight Point: If you are turning angles or deflection angles instead you will be prompted for the backsight point.
Rod Height: With Calculate Elevations on you are prompted to enter the prism height.
You will be prompted for the horizontal angle (or deflection angle)

If you need to change the prism height <esc> and you will be prompted for a new prism height, if you <esc> again you will be prompted for a new instrument point.

Angle data entry

Instrument point: 1
Back site: 2
Enter horizontal angle <0.0000>: 

When you are entering Quick Traverse data you have the options to change the angular input method. To change the angular input mode, enter the upper case letter seen in the prompt for the method of entry you want to change to and press <Enter>. The prompt should then change to reflect your choice.

Note: You need not use the shift and type a capital letter to choose a command line option. For example, to change to Side shot mode you can type either s or S.

The method that is currently set will not be shown as an option in the command line prompts. For example,
if you type s and <Enter> for Side shot mode, the prompt will change to include Traverse and Side shot will no longer be available since you have chosen it as the current mode.

**Traversing a curve**

The Traverse routine allows you to traverse both reverse and compound curves.

Note: You will not be allowed to traverse around a curve if calculate elevation is selected.

**If you type U and <Enter> for cUrve, the following dialog box appears:**

![CGSurvey for AutoCAD](image)

**Enter any two of the curve components.**

**Identify the curve bearing as Chord if the angle, deflection, bearing or azimuth about to be entered is to the PT.**

**Identify the curve bearing as Radius if the angle, deflection, bearing or azimuth about to be entered is to the radius point.**

Click the Clockwise box if the curve is clockwise. If this box is not checked, the curve is considered to be counterclockwise.

If there is a previous traverse leg, check the Tangent Curve checkbox if the curve is tangent to the previous leg. If this checkbox is not checked, the curve is assumed to be non-tangent.

When you have entered the required data: click the OK button.

The input multiplication factor is applied to the curve data you enter (radius, arc length, chord, etc.).

At the next prompt, if the curve is a non-tangent curve, enter the angle, deflection, bearing or azimuth from either the PC to the PT or the PC to the radius point (depending on whether you set Curve Bearing to Chord or Radius). If the curve is tangent to the previous traverse line you will not be asked for the angle and distance.

The curve data will be calculated and shown at the command line:
- Bearing and distance from the PC point to the radius point.
- Bearing and distance from the radius point to the PT point.
- Bearing and distance from the PC point to the PT point.

**Other curve information.**

The radius and PT points will be stored in coordinate file using the STORING POINT prompt.
Closure

At the prompt: azimuth/Bearing/Deflection/Side shot/Curve/Closure/slope distance.
Enter horizontal angle <0.0000>:
Type C and <Enter> to view closure information for the traverse to the current foresight.

Slope/Horizontal Distance Data Entry

If you have selected Slope Dist/Vert. Angle in the Traverse Options tab or switched to slope distances by typing N and <Enter> at the command line, enter the slope distance. Otherwise, enter the horizontal distance.

Note: The following steps are required only if Vertical Angles ON is checked on the Traverse Options tab or if Calculate Elev. was selected on the Global Settings tab.

For slope distance - vertical angle:
Enter the vertical angle.
Depending on the settings in the Traverse Options tab enter one of the following:
Zenith (zero up)
Nadir (zero down)
Transit (zero level)
Transit vertical angles can be full circle (0 - 360), or positive for up and negative for down.

For horizontal distance - vertical distance:
Enter the vertical distance.

Pulldown Menu Location: CGTrav
Keyboard Command: QTR, CG_QTRAV
Prerequisite: Open Coordinate File

Edit Raw File

The Edit Raw File feature allows you to use the CGEditor to create a new raw data file, append to an existing raw data file, or edit an existing raw data file. For further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

CGEditor General Information

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

The CGEditor can create and/or edit six types of data files used by C&G:

Raw Data Files

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.
Map Check Files

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.

Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.

Point Group Files

Point Group Files (formerly called batch point files) are simply a list of point numbers that can define a group of points, a lot/parcel of land, or an alignment. These are ASCII files and have a .PTS extension.

Coordinate Files

CGSurvey supports many different coordinate file formats:

C&G .CRD/.IDX - C&G numeric coordinate files
C&G .CGC/.CGX - C&G alpha-numeric coordinate files
Carlson .CRD - Carlson coordinate file format, numeric and alpha-numeric
Simplicity .ZAK - Simplicity coordinate file
LDT - MDB - Land Desk Top coordinate file

Pulldown Menu Location: CGTrav\Edit Raw File
Keyboard Command: ET, CG_EDIT_RAW
Prerequisite: Open Raw File

Data Collector Transfer

The Data Collector Transfer program allows transfer of data to and from the data collector. The program may also be used to convert raw data and coordinate files to the supported formats.

There are two variables that affect the interaction between your data collector and CGSurvey. One is the data collector itself and the other is the software you use in the data collector. This section provides information on the use of data collectors and software that will interact with CGSurvey.

NOTE: This manual is not a substitute for your data collector manual.
Before using the data collector program, make sure the correct data collector, communication port and communication parameters have been selected in the Settings dialog box.

**Direction of Transfer:**

Choose either "Data Collector to Computer" or "Computer to Data Collector".

**Data Collector and Computer Transfer Options**

**Instructions:** Press the STEP 1 button. Depending on the type data collector, type file and direction of transfer, this option will give you step by step directions on how to proceed.

The Transfer dialog is divided into two sections, left and right. The left part of the dialog box pertains to "Data Collect Options" such as file source, file format and the file being transferred. The right part of the dialog box pertains to the Desk Top "Computer Options". Below are instructions for setting both.

**Data Collector Options**

Pressing the triangle to the right of the edit box will bring up the list of data collectors to choose. From the list select the type of data collector being used.
Use Data Collector:

Check this box to transfer data to/from the data collector. You can also transfer to/from a file in the selected data collectors format.

Use Disk File:

Check this box if the data is in computer file. The data file must be formatted for the data collector selected.

File Name:

If you are importing from a file, or exporting to a file, or are connecting to a data collector that requires a file name for transfer, the File Name edit field will be active. To select the file path click on browse. In the file dialog box specify the path and file name of the file to be opened. select or enter the path and file name of the file desired file.

Transfer Coordinates with Raw:

Chapter 4. CGSurvey Module
Some field software allows unadjusted coordinates to be carried in the raw file as the field data is collected. This checkbox gives you the option to transfer this data or not. If you do not want approximate coordinates that were calculated in the field to be confused with control when processing the raw data, leave this box unchecked.

**Computer Options**

**File type:** Choose the file type you are transferring/convert ing. Example: Raw Data, Coordinate, ASCII, etc.

**File Format:** C&G will import and export several types of file formats for both Raw and Coordinate files.

**Supported Raw Data File Formats:**

- New CGR ..................... *.cgr
- Old C&G ..................... *.raw
- OBS............................*.obs
- Geolab ....................*.iob
- StarNet ..................... *.dat
- SDR2x ....................... *.dat
- SDR33 .......................*.dat

**Supported Coordinate File Formats:**

- C&G AlphaNumeric ...............*.cgc / cgi
- C&G ................................*.crd / idx
- Carlson AlphaNumeric ............*.crd
- Carlson Numeric .................*.crd
- ASCII ...........................*.nez
- ASCII ...........................*.asc
- Geolab ........................*.neo
- StarNet ........................*.pts
- SDR2x ........................*.dat
- SDR33 ...........................*.dat
- Simplicity........................*.zak
- LDT..............................*.mdb

**Description Table:**

To use a description table check "Use Description Table" box.

You have the ability to use multiple description tables. Examples of that might be:
Each of these could have different codes and descriptions and this option would allow you to choose which description table to use for the reduction of this file. To change the description table click the "Browse" button and select the TBL file.

Below is an example of a description table:

![Example of a description table](image)

When using a description table, any INTEGER numbers in the description field of the data coming from the data collector will be replaced by the description in the table. For example, if your description is "13 5", the description put in the coordinate or raw data file will be "CL CMP".

**Transfer**

**Instructions**: The instructions window will guide you step by step through the transfer routine. It will tell you what to do on the data collector, and in what order.

![Instructions](image)

**Transfer**: Once all of the settings are set correct, clicking on the TRANSFER button will begin the transfer between the data collector/file and the desktop.

The **Current Status** window at the bottom of the Transfer Dialog will indicate the status of the transfer.
Settings

At the bottom middle of the main screen is the "Settings" button. The settings control communications, data units and output data path.

Data Collector

The Data Collector dialog box allows you to select a short-list of data collectors you are transferring to and/or from.

When you select the down button to the right of the data collector shown and the "Show Defaults only" box is unchecked, you will see the complete list of all the data collectors that C&G interfaces with.
You also can create a Default List. This default list should consist of the various data collectors your company may have and/or interface with on a daily basis.

You can use the Show Defaults only check box to limit the data collectors which may be selected from the Data Collector list on the main Data Collector Transfer Screen. If this box is checked, only those data collectors you have specified for the default list will be show.

To add a data collector to the default data collector list:
First make sure the Show Defaults only box is unchecked. Next Select a data collector from the list by scrolling up and down the list using the arrow keys. When the new data collector is selected, make sure the communication parameters are correct to the data collector. Once the settings are correct, click Add DC button Now click the Save List to save the changes to the list.

When through setting all of the typical data collectors you may use, check the Show defaults only check box and only those instruments and settings will be displayed for your selection.

To remove a data collector from the default list:
Make sure the Show Defaults only is checked.
Highlight the data collector you wish to remove from list
Click on the Remove DC
Click on the Save List button
Chose OK and verify that the data collector is no longer in the default listing.

Communications

The Communication box allows you to set the following parameters:
Port
Baud rate
Parity
Word length
Stop bits

When a data collector is selected, C&G reads a list of default settings and compares it to the settings currently shown. If the current settings are different than those recommended the defaults will be displayed and a Set Recommended button will be displayed. This allows you to automatically set the recommended communication parameters for your data collector.
The **Measurement** portion of the Settings dialog box pertains to the units of Raw and Coordinate data input.

**Angle Mode**........................... Degrees or Grads
**Direction Mode**....................... Bearing or Azimuth
**Azimuth Direction**:............... North or South
**Vertical Input**....................... Zenith, Nadir or Horizontal
**Distance**.............................. Foot or Meter
**Foot Definition**..................... U.S. or International
**Coordinate Position**............... North-East or East-North
**Description Length**.............. 1 to 100 characters

The **Description Table** portion of the Settings dialog allows you to select the default description table.

As mentioned earlier you can have multiple description tables, here is where you would select the description table to use.

The **Use Description Table** option, when checked, will replace any integer description found in the raw data file with corresponding description found on the description table. When this check box is not checked data will be transferred without translation.

**Default Path** for Output Files

Allows you to set the default location for storing transferred files

---

*Chapter 4. CGSurvey Module*
Receiving Coordinates from Data Collectors:
There is a point protection feature in place when bringing coordinates into an existing coordinate file from a data collector. If the point already exists, and if the coordinate values are different, you will see the following dialog box.

You will have the following options:
**Overwrite:** overwrite existing point
**Do Not Overwrite:** skip point
**Overwrite, Do Not Ask Again:** Overwrite all existing points
**Do Not Overwrite, Do Not Ask again:** Bring in only new points

**Transfer Options**
Depending on the type of data collector that you are using, you will be able to perform some of the following functions:

- Receive raw data from the data collector or file.
- Send raw data to the data collector or file.
- Receive coordinates from the data collector or file.
- Send coordinates to the data collector.
- Send a program to the data collector.
- Execute a program on the data collector.
- Delete files on data collector.
- View and/or Select files on data collector.
- Format data area on the data collector.

As data is received from a particular data collector or file, it is converted to a .CGR or .CRD file (or other supported format).
Data that is sent to the data collector is converted from the .CGR or .CRD format to the data collector format.

When data is received from a data collector, a read-only file in the data collector’s native format is created and stored on the computer. If it is a raw data file, it has a .R$$ extension. If it is a coordinate file, it has a .C$$ extension.
Select Points

When transferring coordinates to the data collector you may choose which points are to be transferred. The default is ALL points. When you click on the Select Points button the following dialog box comes up.

**Change file select from:** Click the file button to select the coordinate file that you want transfer coordinates from.

**Choose Points:** This option allows you to select groups of points to be included from the file you have opened, using the C&G selection options.

**All Points:** All Points in the file will be selected.

**Block:** select blocks of Points.

**Desc:** select points by their description.
**Match Case:** Case sensitive compare.
**Match Whole Word Only:** If your description is BOC this box is NOT checked, points with the descriptions BOC, BOC1, BOC2, etc. would all be included. If the box were checked, only points with the description BOC would be included.

**Code:** select points by Code

**Match Case:** Match the case of the text
**Match Whole Word Only:** If checked, in the above example, only AB would be selected. Descriptions of AB1, ABC and ABB would not.

**Elevation:** select points by elevation

**Low Value:**
Point ID: Point Number
Elevation: elevation at point

**High Value:**
Point ID: Point Number
Elevation: elevation at point

If a point number is entered in the point ID box the elevation for that point will be used for either the high or low elevation. You may however enter an elevation only.

**In Radius:** select all the points within a given radius.
If a point number is entered in the point ID box, the northing and easting of that point will be used for the center of the search circle. To manually enter a northing and easting, leave the Point ID box empty and enter the values for the northing and easting of the circle. Enter the radius for the search circle.

**In Rectangle:** Select all the points within a given rectangle.

If a point number is entered in the point ID box, the northing and easting of that point will be used for that corner of the rectangle. To manually enter a northing and easting, leave the Point ID box empty and the northing and easting values. The two points defined the diagonal corners of the rectangle.

**Choice:** This option allows you to choose to include or exclude points previously in the C&G select point dialog box. Example:

**In the choose points dialog box:** select by Desc  
**Then type:** GS as the description 
**in the choice dialog box:** select Exclude  
**Any point that has "GS" in the description field will be removed from the selection set.**

**Total selected Points:** the total number of points selected is shown in the lower right hand corner of the dialog box.  
**Default Column Width:** The columns have a default width. If you have changed the width of a column, say NORTHING, you may press this button to go back to the defualt widths.

**The remainder of this section discusses specific data collectors and software.**
Establish a connection between the data collector and desktop computer with a standard 9-Pin serial cable, USB cable, Bluetooth, etc. Check the settings as shown above.

**Download a Description Table**

You can transfer the desktop description table directly to the CG-FieldPlus data collector. The table will be placed in the data collector's DC_DESC.TBL file. CG-Field will let you use codes without a description table. Simply delete the DC_CODES file from the data collector and use the code numbers to enter descriptions. When you transfer the file to the desk top, the codes will automatically be replaced with the appropriate description. (This allows you to combine codes.) For example, if you enter [1 20 30], in the description field on the data collector when the transfer takes place these numbers will be read from the desk top description table and converted to the corresponding description, such as [BL* TC SW].

**Receiving Raw Data from CG-Field**

*NOTE:* When uploading raw data from a data collector using CG-FieldPlus, a read-only file in the original CG-Field format is created on the computer (in the data directory) with a .R$$ extension.

On the desk top data collection transfer dialog box, set the following:

- **Set transfer method to Data Collector to Computer.**
  - **Data Collector Type:** CGFIELD+
  - **Use Data Collector:**
  - **Transfer Coordinates with raw:** yes or no (your choice)
  - **File Type:** Raw Data
  - **File Format:** C&G (*.cgr)
  - **File Name:** enter the path and name where the file is to be stored or click on the "Browse" button and select the path.
  - **Description Table:** enter the path where the Description Table is stored or click on the "Browse" button and select the path
  - **Select Transfer when all settings are correct.**

On the data collector Utils menu, select:

1: C&G Transfer
2: Send Raw Data
Enter or select the raw data file
The file will be transferred.

*NOTE:* CG-Field uses only 2-character point codes. If you have CGSurvey set for 4-character point codes, the CG-Field file will be converted to a 4-character format but it will still have the correct 2-character code. If you download the same file back to the data collector, the downloaded file will be correct if you did not add any codes that actually consist of 4 characters.

**Receiving Coordinate File from CG-Field**

On the desk top data collection transfer dialog box, set the following:

- **Transfer Data Collector to Computer**
  - **Data Collector:** CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)

File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path

Press Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
3:Send Coords

Select Points
All points
Blocks of points
From points file
The file will be transferred.

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

Sending Coordinate File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
3:Receive Coords

Transfer: Computer TO Data Collector
Data Collector: CGFIELD+

Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)

File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.

Check the Select Points settings:
This tool allows you to select what group or groups of coordinates are transferred to the data collector.
Press Transfer: when all settings are correct.

NOTE: You should not download a file containing a 4-character code to your data collector. You will be warned that the last 2 characters of the code will not be sent. This means that a code of 1584 will be received as 15.

Receiving ASCII File from CG-Field

On the desk top data collection transfer dialog box, set the following:
Transfer Data Collector to Computer
Data Collector: CGFIELD+

Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.

Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
Sending ASCII File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
5:Receive ASCII

On the desk top data collection transfer dialog box, set the following:
Transfer Computer to Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse” button and select the path.
Select Transfer when all settings are correct.
The following are examples of typical data collection transfer settings. There will be cases with certain models or manufactures where special instructions will be required and C&G will provide those as needed.

There three different dialog boxes involved with data collection transfer:
C&G Data Collection Transfer (shown above)
Settings
Description Table Editor.

The function and settings for each of these is described in detail in the previous pages.
The examples shown on the following pages show transfers directly from and to data collectors. These same transfer routines will also work with files that have been downloaded to the desktop computer.

**File Conversion Utility**

To convert data from files check the Use Disc File box and either hand enter the path and name or click on "Browse" and search for the file location.

These files need to be in the correct data file format.

**Receiving Raw Data**

On the desktop data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector:** (select data collector from list)

**Check Use Data Collector:**

**Transfer Coordinates with raw:** -yes or no (your choice)
Receiving Coordinate Data

On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector:** (select data collector from list)

**Use Data Collector:**

**File Type:** Coordinate

**File Format:** C&G (*.crd) or C&G (*.cgc)

**File:** enter the path to store the file or click on the Browse button and select the path.

**Description Table:** enter the path where the Desc Table is located or click on the Browse button and select the path.

**Press Transfer:** when all settings are correct.

**Begin transfer from data collector**

**NOTE:** In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

Receiving ASCII Data
On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector:** (select data collector from list)

**Use Data Collector:**

**File Type:** Coordinate

**File Format:** ASCII (*.nez)

**File:** enter the path to store the file or click on the Browse button and select the path.

**Description Table:** enter the path where the Desc Table is stored or click on the File button and select the path.

**Select Transfer:** when all settings are correct.

**Begin transfer from data collector**

**Sending Coordinate Data**
Prepare Data collector to receive Coordinate file
On the desk top data collection transfer dialog box, set the following:

Select Computer to Data Collector
Data Collector: (select data collector from list)
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File: enter the path to file or click on the Browse button and file
Check the Select Points setting:
Press Transfer: when all settings are correct.

Sending ASCII File
On the desktop data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** ASCII

**File:** enter the path to store the file or click on the bROWSE button and select the path

**Press Transfer:** when all settings are correct.

### Sending Description Table
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**
- **Data Collector**: (select data collector from list)
- **File Type**: Description Table
- **File**: enter the path to store the file or click on the File button and select the path
- **Press Transfer**: when all settings are correct.

**SurvCE Data Collector**

You can receive coordinates and raw data from the data collector, or send coordinates to the data collector. Make sure SurvCE is selected as the data collector.

**Receive Coordinates from SurvCE**

![Data Collector to Computer dialog box](image)

On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector.

Set **FILE TYPE to Coordinate**: and select the desired File Format.

On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer.
On the desktop, select **BROWSE button next to the FILENAME field**: You will see the coordinate files that are on SurvCE.

**Select the File you wish to download**: and press OK.
Press the Transfer button. If you do not have a destination FILE NAME selected, you will see the following dialog:

In this case, the file already exists. If you press OK the coordinates will be written to the existing file. Point Overwrite Protection will allow you to select which points you wish to bring in. You can decide individually whether you want to overwrite a point or not, or you can select overwrite ALL points, or you can select to bring in ONLY new points.

A file with the same name and a C$$ extension will also be created with the data that came directly from survCE in survCE’s format. This file is ready-only and can be archived for legal purposes.

Receive Raw Data from SurvCE
On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector.
Set FILE TYPE to Raw Data: and select the desired File Format.
On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer.
On the desktop, select BROWSE button next to the FILENAME field: You will see the raw data files that are on SurvCE.

Select the File you wish to download: and press OK.

The selected raw data file will be transferred and converted to the selected format. A file with the same name and a R$$ extension will also be created with the data that came directly from survCE in SurvCE's format.
Send Coordinates to SurvCE

**Select Computer to Data collector.** Make sure the Data Collector TYPE is set to SurvCE: select the file to be set to SurvCE (N_DRUIDH.crd). If you do not select a destination name, it will be sent to the same named file as the source.

**If you do not want to send ALL the points, but need to select specific point:** press the SELECT POINTS button and choose the point to transfer.

**On the data collector select FILE > DATA TRANSFER:** Choose Carlson/C&G Transfer

**On the Desktop, Press the TRANSFER BUTTON:** The selected coordinates will be transferred.

If the file already exists on SurvCE, you will see the following dialog:

You have the following choices:
- Overwrite the existing file
- Skip the file (do nothing)
- Rename the file
- Merge the points.
If you select the Merge option, you will see Carlson’s standard merge dialog:

This dialog allows you to fix all conflicts prior to transferring the points.

**TOPCON DATA COLLECTORS**

Use Topcon cable A-5 if your computer has a 25-pin serial port, or Topcon cable A-16 if your computer has a 9-pin serial port. When uploading raw data from a Topcon/TDS data collector, a read-only file in the original data collector format is created on the computer (in the data directory) with a .R$$ extension. When you send the description table to a Topcon/TDS data collector, only the first 999 descriptions will be sent.

**FC1 DATA COLLECTOR**

For the transfer program to be able to access any data in the FC1, it must be stored in the FC1 using the Program 2 supplied with the FC1 transfer software. First locate the necessary cables to connect the FC1 to your computer. (your dealer should be able to help you with this).

**NOTE:** Currently, the only programs that are supported are ET1 and GTS3, which are supplied with the system.

Follow these instructions:
Select either ET-1 or GTS-3 when prompted. Once you have loaded Program 2 into the FC1, you may enter your field data in either of two ways. The first way, is by connecting the FC1 to your total station and let the total station record angular and distance measurements for you by using the ET1 (GTS3) section of the FC1 program. The other way is to use the Manual Entry section of the program to store all of your field data directly through the FC1’s keyboard.

**Collecting Data using the FC1**
(The following steps will be followed no matter which data entry method you use):

1) Set up data recording mode in the FC1.
2) Enter job information: job name, operator, instrument number, date, temperature, pressure.
3) Enter instrument point information: point number, H.I., backsight point, angle in instrument to backsight.
4) Enter foresight point information: point number, rod height, horizontal and vertical angles, distance.
5) If there are other foresights from the same instrument point, repeat step 4; or if you have another instrument setup, go to step 3; or if you are through, go to the end of the program.

**NOTE:** Never press the `<skip>` key when the FC1 is asking for data. Only use the `<skip>` key to by-pass "go to" options (see step 5 below).

### Automatic Recording of Data

1) To set up the recording mode, have the FC1 connected to the ET1 (GTS3), and turned on. Wait until the left side of the display says READY.

   **If the right side of the display says PRG > 2,** then you are ready for step 1A.

   **Otherwise,** press these keys: `<func>`, `<#>`, `<Enter>` and then go to step 1B below.

   A) **Press the `<F1>` key.**

   B) **When the display says GOTO 7 ET1-PROG? ("GOTO 7 GTS3-PRG"),** press the `<Enter>` key.

2) Enter any name you want for the job-id:

   Enter the name of the operator.
   Enter the instrument number.
   Enter the date, temperature, and pressure.

3) Sight the backsight point with the instrument:

   Enter the instrument point number.
   Enter the instrument height (H.I.).
   Enter the backsight point number.
   Press `<Enter>` for the rod height.
   Press `<Enter>` when the display says REC MODE 2 (REC V/H `< MODE?` on GTS3).

4) **When the display says MODE >,** press `<2>` and the ET1 should send angular information to the FC1.

5) **Turn to the foresight.**

   Enter the foresight point number, and press `<Enter>`.
   Enter a description for the foresight and press `<Enter>`.
   Enter the foresight rod height and press `<Enter>`.

   **When the REC MD3-DR/2R (REC SD/V/HMODE?) message appears,** press `<Enter>`, then choose mode 3 if you are entering a direct angle.

   If this is your second angle to that foresight, then you may use mode 2 to record angles only.

5) After step 4, then you should see this message in the display: GOTO 18 FS.PT#?. If you wish to turn more angles from the current instrument point, then press `<Enter>`, and go back to step 4.

   - **or**-

   **Press `<Skip>`**. The next message will be GOTO 13 INST.PT? If you want to record another instrument set-up, then press `<Enter>`.

   - **or**-

   **Press `<Skip>`**. The next message is, GOTO 8 OPER.? To change operators, press `<Enter>`, and go to step 2.

   - **or**-

   **Press `<Skip>`**. The next message is, GOTO 53 END? To end input for this job, press `<Enter>`.

### Steps on Manual Recording of Data

1) To set up the recording mode, have the FC1 turned on. Wait until the left side of the display says READY.

   **If the right side of the display, says PRG > 2** then you are ready for step 1A.
Otherwise press these keys: \(<\text{func}>\), \(<\#>\), \(<\text{Enter}>\) and go to step 1B.

A) Press the \(<\text{F1}>\) key.
B) When the display says GOTO 7 ET1-PROG? (GOTO 7 GTS3-PRG): press the \(<\text{skip}>\) key.

When the display says GOTO 30 MANUAL?: press the \(<\text{Enter}>\) key.

2) Enter any name you want for the job-id:
   Enter the name of the operator:
   Enter the instrument number:
   Enter the date, temperature, and pressure:
   3) Enter the instrument point number:
   Enter the instrument height (H.I.).
   Enter the backsight point number:
   Enter the rod height if desired:
   Enter the angle in the instrument: when the backsight was taken.
   Enter the vertical angle and distance: if desired.

4) Turn to your foresight. Enter the foresight point number, and press \(<\text{Enter}>\).

Enter a description for the foresight and press \(<\text{Enter}>\).

Enter the foresight rod height and press \(<\text{Enter}>\).

Enter the horizontal angle, slope distance, and vertical angle to the foresight.

5) After step 4, then you should see this message in the display: GOTO 43 FS. PT#?

If you wish to turn more angles from the current instrument point, then press \(<\text{Enter}>\), and go back to Step 4.

-or-

Press \(<\text{Skip}>\). The next message will be GOTO 36 INST.PT? If you want to record another instrument set-up, then press \(<\text{Enter}>\).

-or-

Press \(<\text{Skip}>\). The next message is GOTO 31 OPER.? To change operators, press \(<\text{Enter}>\), and go to step 2.

-or-

Press \(<\text{Skip}>\). The next message is GOTO 1 MENU? To go to the menu for another job, press \(<\text{Enter}>\).

-or-

Press \(<\text{Skip}>\). The next message is END. Press \(<\text{Enter}>\) to end entry for this session.

**Receive Data from FC1**

Once you have your data stored in the FC1, you must upload it to the computer.

Select the Receive Raw Data function. If you have already dumped the data stored on the FC1 to a computer file (in the Topcon format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

**NOTE:** To power your FC1 while sending data to the computer, you must plug the power cable into the signal port at the top of the FC1 and toggle the FC1's power switch to EXT.

**TOPCON PROPAC DATA COLLECTOR**

To enable the Propac to collect raw data in a format Suitable for CG-Survey's data transfer program the CG program must be installed on the 71B. To load the software: connect the Propac to the computer com port.

Follow the directions to download.
You may store the CG program in a freeport on the 71B. This has several advantages, the main one being it will not be lost if the batteries die.

Under the Propac options choose Load CG Program Into Propac.

On the 71B:
Type Freeport(.01) and key <Endline>.
Type COPY CG TO :PORT(.01) and key <Endline>.

For ROM Versions Prior to 1.75
Type DEF KEY 'f7',"USER @ RUNCG": and key <Endline>.

For ROM Versions 1.75 or Later
Type DEF KEY 'f7','USER @ CONT PRGM2": and key <Endline>.

This will set up the raw data collection program to run on the Propac when the yellow function key and the <7> key are pressed. Unless something happens to the 71B, you should not need to reinstall the CG-Field program again.

Now delete the CG-Field program from the main memory of the Propac by typing PURGE CG:MAIN and key <Endline>. The program is still stored in the freeport.

To use the CG-RAW data program, turn the Propac on and type RUN PRO then key <Endline>. From the KEYS prompt press the yellow function key then the <7> key. This will start the CG program, then just follow the prompts.

The CG raw data program is the only one needed on the Propac other than the Propac options already available. If you are collecting coordinates and elevations instead of raw data, simply follow the Propac instructions.

To transfer the collected data to and from the computer, choose the Propac option you wish and follow the directions on the screen.

If you have already downloaded the data stored on the Propac to a computer file (in the Propac format), you may choose to receive the data directly from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**FC-4 DATA COLLECTOR**

The C&G data collector transfer program can accept data that was collected from the FC-4 in either the traverse mode or topo mode. It can receive coordinates from the FC-4 and also send coordinates to the FC-4 for stakeout. The CG data collector transfer program supports most the valid methods of collecting data in the traverse or topo mode of the FC-4 (including the ability to collected direct and reverse angles). Refer to the FC-4 users manual to learn the different methods of data collection supported by the FC-4.

Special Features - When translating the FC-4 file to a raw data file using the C&G data collector transfer program:

1) If an FC-4 record is not used, the record will be placed in the raw data file as a comment with the message Not Used appended. No FC-4 record will be ignored. For example, *123 Not Used
2) Remarks ("R" records) will be placed in the raw data file as a comment record.
3) Coordinates will be placed in the raw data file as a coordinate record, (C 23 10000.0000 10000.0000 923.24 'TP).
4)When using the FC-4 Benchmark function, the following will be placed in the raw data file:
A) The benchmark coordinates.
B) The measurements to the benchmark as a foresight point.
5) When using the FC-4 Angle-Offset function the following will be placed in the raw data file:
A) A comment line saying the next line is an angle/offset and showing the 1st and 2nd angle recorded to the point.
B) A foresight record combining the first distance measurement and the 2nd angle measurement.
6) When using the FC-4 Distance-Offset function the following will be placed in the raw data file:
A) A comment line saying the next line is a distance/offset and showing the slope distance, vertical angle and offset distance measured to the base point.
B) A foresight record with a new slope distance and vertical angle calculated from the above information.

7) When using the FC-4 Perpendicular-Offset function the following will be placed in the raw data file:
A) The foresight record to the base point.
B) A comment line saying the next line is a perpendicular offset and showing the offset forward/backward, the offset left/right and the offset up/down.
C) A foresight record with a new horizontal angle, slope distance and vertical angle calculated from the above information.

**NOTE:** If there is no left/right offset, data will not convert correctly to a CG-SURVEY raw data record. For example, if the Perpendicular Offset routine is used to locate a point away from the instrument but on the same line, the resulting data record will use the wrong horizontal angle.

8) Backsight azimuths are transferred to the .CGR file as reference azimuths.

When a file is first created on the FC-4 the user will be prompted for some header information. When the data is transferred to the computer, the C&G data collection transfer program will use the job-id as the file name for the raw data file created on the computer.

To prepare the data collector and computer for data transfer, connect the A-5 or A-16 cable to the serial port of the FC-4 and to the appropriate serial port of the computer. Make sure the correct data collector comm port has been chosen in Settings Dialog.

Choose the appropriate menu option on the FC-4, then follow the instructions and answer the prompts as they appear on the screen. Once the raw data has been downloaded into the computer the raw data can be edited, reduced and printed out from the Traverse/Input Edit program.

If you have already downloaded the data stored on the FC-4 to a file on the computer, you can transfer the data using the "Use Disc File" command.

**TOPCON and TDS**

**Transferring Data**

On the C&G Data Collector Transfer screen set the data collector option to: Choose Settings to make sure all options are set correctly.
Note: See opening section of this chapter for detailed instructions on the Settings dialog box and on sending and receiving files.

Sending Description Table to 48 When sending the description table (DC_CODES file) to the 48, the following occurs:
A new file (DESCRIPT.TXT) is created in the data directory on the computer.

The first 200 descriptions are duplicated from the DC_CODES file.
After that, the first 100 descriptions are reproduced 7 times with the following mapping codes preceding the descriptions:
201 - 300 BL*(DESC)
301 - 400 EL*(DESC)
401 - 500 CL*(DESC)
501 - 600 CF*(DESC)
601 - 700 OC*(DESC)
701 - 800 PC*(DESC)
801 - 900 PT*(DESC)

The DESCRIP.TXT file is then sent to the 48.

TOPCON CR2 CARD READER

Data collected and stored using the Topcon Card Reader is in the same format as data on the FC-4. All data format rules for the FC-4 apply here.

Set-Up
Card Read Preparation. Before using the card reader it is necessary to set the two DIP switches on the bottom of the unit to the settings described below. The direction on the switch which is marked 'OFF' is really a '1'. You should read the attached label, not the switches.

The CR2 should be set as follows:
Baud: 19200
Parity: None
Stop Bits: 1
Word: 8
SW1 DIP Switch: Set the communication parameters

SW2 DIP Switch: Sets other parameters

Use the interface cable supplied with the CR2 unit and plug it into the comm port on the computer. Make sure you select the Topcon CR2 data collector and the correct comm port.

The Card Reader program allows:
1) Receive raw data from the CR2 or from a CR2 file.
2) Receive coordinates from the CR2 or a CR2 file.
3) Send coordinates to the CR2.
4) Send or receive a description table to CR2.
5) Receive description table.
6) Send or receive ASCII files from the CR2.
7) Send an executable (EXE) file to the CR2.
8) Catalog (or directory) of all files on CR2.
9) Delete files on the CR2.
10) Format cards for the CR2.

Receiving Data from the CR2
You may receive raw data files (.R), coordinate files (.N), ASCII files or description table from the CR2. All files on the CR2 of the type you wish to receive will be shown on the screen.

Raw Data
Coordinates
ASCII
Description Table

**Receiving Data from a CR2 File**

If you have already downloaded the data stored on the CR2 to a file on the computer, you may choose to receive the data from the file.

**Sending Data to the CR2**

You may send coordinate (.CRD) files, ASCII files, EXE files or description table to the CR2. Select the file you wish to send. You may not send a file to the card reader that already exists on the CR2. You must delete the file first. The.CRD files will be converted to .N files. ASCII files will be transferred without conversion, (make sure the file you are transferring is a true ASCII file).

**EXE files**

Programs with .EXE extensions can be transferred to the CR2. These files will be transferred with a .X extension.

**Note:** See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

**Catalog:** The catalog function will show you all existing files on the Topcon Card Reader.

**Deleting Files:** All files on the CR2 will be shown on the screen. Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.

**Format:** The format function will allow you to format a card, making it ready to accept (store) data. If the card is already formatted, you will be warned that all information on the card will be lost, be careful.

**SOKKIA (LIETZ) SDR2 DATA COLLECTOR**

**General Information**

Use the cable supplied with the SDR2 data collector to plug into your computer's serial port.

When uploading or downloading to or from the computer, turn the switch on the cable toward the word PRINTER. If this does not work, turn the switch toward the word COMPUTER and try again. If you still have trouble please call us.

In order to use the Lietz SDR2 data collector with the transfer program, there are 4 areas that you must consider: (1) Entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, (3) sending calculated coordinates back to the data collector, and (4) the data collector code conversion table which converts numeric codes for points into English-language descriptions as the data is sent to the computer.

Sokkia (Lietz) data collectors allow you to enter attribute data. To use attribute data with CG-SURVEY, it must be appended to the description records in the following format:

DESCRIPTION [attribute name] attribute
Entering Data into the Data Collector

Note: that all of the following assume that you have a Getting Started book and Operator's Manual from the Lietz Company.

1) To begin a new job, press <clear> until Select operation appears in the display. Press the <Menu> key. When JOB appears in the display, press <Enter>, and enter the job name and scale factor.

2) To enter field data, press <clear> until Select operation appears in the display. Press the <Prog>. When Traverse appears in the display, press <Enter> and begin traversing.

2a) You may use the TOPO program rather than the Traverse program. If you use this program, you must use the R option when sending data to your computer. The "Transferring Field Data to the Computer" section of this contains more about this.

Note: The coordinates that you enter for the first instrument point are for the internal use of the SDR2, and can be changed when your field data gets to the computer.

Note: When recording your first backsight information, simply enter an azimuth from the instrument point to the backsight (0.0000 will do). The azimuth information is also only used internally in the SDR2. You can change all of that as you reduce your field notes on the computer.

Note: At each instrument setup, the first angle recorded must be to your backsight. Your instrument may be "zeroed" or not, but when the Traverse Reduction program runs, it will subtract the backsight angle from the foresight angles.

Transferring Field Data to the Computer

If you have already dumped the data stored on the SDR to a computer file (in the SDR format), you may choose option to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

Before data can be transferred in either direction between the computer and the SDR2, you must set up the transfer parameters in the SDR2. Once these have been set, they will not change, until you change them again. You do not have to set them each time. (The only parameter that you may wish to change is the baud rate.)

In our tests, the computer can receive data from the SDR2 at 4800 baud, its fastest speed, but the SDR2 could only receive points at 1200 baud. For fastest transmissions to and from the SDR2, you might wish to change this parameter in the SDR2.

The SDR-22 and SDR-24 data collectors will send to the computer at 9600 baud and receive data from the computer at 4800 baud.

1) Set up parameters by pressing <clear> until the message Select operation appears in the SDR2 display. Then, press <Menu>. Press the up or down arrow until Parameters appears in the display, then press <Enter>. You can then go from one parameter to the next by pressing the up or down arrows. When a parameter you wish to change shows on the display, press the <Edit> key, and change it. (See the SDR2 operator's manual.)

These parameters must be in effect:
Baud: 4800 (or 1200 for sending to the SDR2, see above discussion.)
2) **After the parameters have been set**, simply connect the SDR2 to the computer, and select the transmission option. (On the Lietz transfer cable, there is a switch that must be set to DTE.)

3) **Choose the same baud rate at the computer as you selected in the SDR2 parameters. When the computer says Waiting for data...**, press <clear> on the SDR2 until Select operation shows in the display window. Press the <Menu> key. Press an up or down arrow key until Comms output shows in the display, then press <Enter> on the SDR2. Answer <N> if you do not wish to send all jobs. Then enter the job that you do wish to send. (See the SDR2 manual for a complete discussion of this process.)

4) **The SDR2 should then send its information to the computer.**

**Note:** As each job record is encountered in the computer will ask you for a file name to store the data in. You may press <Enter> to use the same name as was used in the SDR2 or enter another name. You must use a valid DOS name (all numbers and letters of 8 or less characters will be fine.)

Attribute data collected by the SDR (13AT records) is appended to the descriptions as follows: DESC[Attribute Name]Attribute

Example: PIPE[diameter]18''

**Transferring Coordinates to the SDR2**

Be careful of the units when transferring coordinates. For example, if the SDR2 is set to Metric Mode, the SDR2 will automatically convert the coordinates from feet to meters. Before you can transfer coordinates to the SDR2, you must first set up the transfer parameters in the SDR2. Refer to the first part of the previous section for details about how to do this. Then:

1) **Ready the SDR2 by pressing <clear> until Select operation appears on the display. Press the <Menu> key. Then press the up or down arrows until Comms input appears on the menu. Press <Enter>.**

2) **Select the Send Coordinates option and press Transfer.**

3) **Select the coordinate file on the computer.**

4) **Choose which coordinates to send.**

**SOKKIA (LIETZ) SDR33 DATA COLLECTOR**

The SDR33 works the same as the SDR2. In Equipment Options there are two SDR33 choices, because when creating a new job on a SDR33 the format is determined by setting the Point ID field to Numeric (4) or Alpha (14).

**SDR33 4-Pt**

To transfer data to CG-SURVEY, select this setting if your SDR33 is set to Numeric (4). The highest point number allowed is 9,999.
The C&G *.cgc files allow 10 character Alphanumeric point numbers. While C&G *.crd files allow only 5 digit numeric point numbers. To transfer a SDR33, set to Alpha (14), the file format setting must be set to *.cgc.

**LEICA (WILD) GRE3/GRE4 AND GIF-2 INTERFACE**

### Set Up for GRE3/GRE4

Select the Wild: GIF-2 under Equipment Options. Before transferring data from the GRE3/4 to your computer, you must first set up the transfer parameters in the GRE3. To do this follow these steps on the GRE3/4:

1) `<Set> <Mode> <7><0> <Run> <4><8><0><0> <Run> <Run>`
(Sets the baud rate to 4800. If you wish, you may leave it at 2400, which is the rate the T2000 needs to communicate with the GRE3/4.)

2) `<Set> <Mode> <7><1> <Run> <2> <Run> <Run>`
(Sets even parity.)

3) `<Set> <Mode> <7><2> <Run> <1> <Run> <Run>`
(Use protocol.)

4) `<Set> <Mode> <7><3> <Run> <0> <Run> <Run>`
(<CR> only.)

5) `<Set> <Mode> <7><4> <Run> <2> <Run> <Run>`
(ACK/NAK + <CR>.)

6) `<Set> <Mode> <4><0> <Run> <4> <Run> <Run>`
(DDD.MMSSS).
7) <Set> <Mode> <4> <1> <Run> <1> <Run> <Run> (Feet).
8) <Set> <Form> <.> <Run> <Rec>
   (for the T2000)
   -or-
   <SET> <FORM> <+/-> <.> <RUN> <1> <1> <RUN> <REC>
   (for the T1000)

Note: The above parameters do not "go away" when the GRE3/4 is switched off. They will stay the same until you change them or re-initialize everything.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

Switch Settings/Cable

Option 1
GIF-2 Switches Cable Configuration
= X GRE-3/4 Computer
S1 < 2 < > 3
S2 < 3 < > 2
S7 < 7 < > 7
5 <
   (Jump 5, 6, 8, 20) 6 <
8 <
20 <

Option 2
GIF-2 Switches Cable Configuration
= X GRE-3/4 Computer
S1 < 2 < > 3
S2 < 2 < > 2
S7 < 3 < > 7
7 <
5
   (Jump 5, 6, 8, 20) 6 <
8 <
20 <

Data Collection Format for GRE3, GRE4, GIF-10

The transfer program expects your data to be in a specific format. To get your data in this format, follow these steps.

1) To begin a new job enter a "CODE 1" block into the GRE3/4. Example:
RDY [CODE]
CODE [1]
I1 ? [RUN]
your job number (Example: 87001)
[RUN]
I2 ? job date (Example: 091687 for Sept. 16, 1987)
[RUN]
2) Define the first automatic point number for your first foresight. Example:
RDY [SET]
SET [NR0]
S NR [2] for point number 2 as first foresight.
[RUN]

3) At each instrument point, enter a "CODE 2" block into the GRE3/4. Example:
RDY [CODE]
CODE [2]
[RUN]
[RUN]
I2 ? [instrument height] EX: [550] for 5.50 feet.
[RUN]
I3 ? [REC]

Note: Each instrument point "CODE 2" block must be followed by a measurement reading to your backsight. You will probably need to change the point number for the backsight by:

RDY [NR]
NR [point number] EX: 4 for backsighting point 4.
[RUN]
THEN:
RDY [MEAS]
REC [REC]
-or-
ALL on T1000 will store in GRE3/4

4) Record your foresights. If necessary, change the rod height and/or the description of the foresight. Use "CODE 3" or "CODE 4" to do this. Both codes are essentially the same, but one asks for the description first and the other asks for the rod height first, allowing you to skip the second entry by pressing [REC] rather than entering a value (see the third example below). This step may be skipped if you do not wish to change either rod height or description from the previous entry.

Example 1:
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [0][1] Description = 01 (must be 2 digits)
[RUN]
I2 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I3 ? [REC]
See following section on Setting-up Description Codes.

Example 2:
RDY [CODE]
[RUN]
I1 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I2 ? [1][0] Description = 10 (must be 2 digits)
[RUN]
Example 3:
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [1][2] Description = 12 (must be 2 digits)
[RUN]
I2 ? [REC] (leave the rod height the same)

5) Take your measurement (make sure that the point number is correct first):
RDY [MEAS]
REC [REC]

6) Now, go to step 4 for another foresight or to step 3 for another instrument set-up:

Uploading from Data Collector to the Computer

If you have already dumped the data stored on the GIF-2 to a computer file you may choose to receive the data from
the file. Enter the file name that contains the data. After you have collected your field data, connect the GRE3/4
to your computer. Then select the receive option on the computer. The baud rate in the computer must match the
baud rate in the GRE3/4. After selecting the baud rate on the computer, follow the steps on the screen to initiate
transmission.

Those steps are:
1) Connect the GRE-3/4 to the computer, turn it on, and wait for RDY to show on
the display.
3) Press <GoTo>, press <Run>, and wait for the GRE-3/4 to display DC D.

After the computer detects the end of transmission, it will begin to format the data in a usable form. When
each job record is encountered (CODE 1), you will be prompted to give the computer the name that you want to
enter the file name for that job.

Sending Coordinates to the GRE-3/4

From the Menu, select the send coordinates option. The baud rate in the computer must match the baud rate in the
GRE3/4. Initiate transmission on the GRE-3/4 by doing the following:

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information
on sending and receiving files.

1) On GRE-3/4, SET MODE 80 <Run> 2 <Run> <Run> to select file 2.
2) On GRE-3/4, SET MODE 81 <Run> <#blocks> <Run> <Run> to dimension
file 2.
3) Press any key to continue:
4) Next, select the points you wish to send: The transmission will begin.

LEICA (WILD) GIF-10 INTERFACE
Receiving Raw Data from GIF-10 Interface:

Select the receive raw data option on the computer. If you have already dumped the data stored on the GIF-10 to a computer file (in the Wild format), you may choose receive the data from the file. Enter the file name that contains the data.

The baud rate in the computer must match the baud rate in the GIF-10. Do the following on the GIF-10:

1) Set the comm parameters as follows:
    Baud: (your choice)
    Parity: EVEN
    Protoc: ACK/NAK
    Stop Bit: 2
    End Mark: CR
    Connected AS: DTE
2) Put the GIF-10 in upload mode by selecting <Send> on the GIF-10.
3) Press <Run> on the GIF-10 and select the file you wish to send.
4) Press <Run> on the GIF-10.

Sending Coordinates to the GIF-10 Interface:

Select the send coordinates option. The baud rate in the computer must match the baud rate in the GIF-10. Do the following on the GIF-10:

1) Create receive file in GIF-10 now.
2) Put the GIF-10 in download mode by selecting Receive on the GIF-10.

Select the points you wish to send. The transmission will begin.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

LEICA (WILD) GIF-10/WS

This is a Wild GIF-10 interface that will accept data in the same format as WildSoft. You will be asked for the Observation Pattern when the file is transferred. This pattern can be either BS-FS-FS-BS or BS-FS-BS-FS. As with WildSoft, codes 101 and above will be treated as descriptor codes. Code 100 will be subtracted from the descriptor code and that description will be read from CG-SURVEY's description table. So 101 is description 1, 102 is description 2, and so forth.

The following table shows acceptable WildSoft data collection codes:

<table>
<thead>
<tr>
<th>WildSoft Data Collection Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Function</td>
</tr>
<tr>
<td>1 Start Job</td>
</tr>
<tr>
<td>2 Occupy a Point</td>
</tr>
<tr>
<td>3 FS to Traverse Point</td>
</tr>
<tr>
<td>11 Assign Coordinates</td>
</tr>
<tr>
<td>13 Target Height</td>
</tr>
<tr>
<td>14 Add to Target Height</td>
</tr>
</tbody>
</table>

Chapter 4. CGSurvey Module
LEICA (WILD) GIF-10/WS2

This is the exact same interface as the GIF-10/WS except 100 is not subtracted from the descriptor code.

LEICA (WILD) GIF-10/TOPOS

This is a Wild GIF-10 interface that will accept data in the same format as the Canadian software TOPOS. To select this format, choose GIF-10/TOP from the data collector choices in the Equipment Options. The following information explains the format.

These six Wild codes are used:

<table>
<thead>
<tr>
<th>Code</th>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Rectype</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>Job Name</td>
<td>Date</td>
<td>Temperature</td>
<td>Pressure</td>
<td>New Job</td>
</tr>
<tr>
<td>10</td>
<td>Label #</td>
<td>HI Instrument Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Label #</td>
<td>RH Backsight Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Label #</td>
<td>RH Trav. Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Label #</td>
<td>RH Side Shot Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Label #</td>
<td>RH Offset Angle SS</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) If RH (rod height) is 999 it will be considered no value (do not calculate elevation for this point).
2) The Label# (point description number) can contain up to eight characters. The first four and last four will be read as separate descriptions. For example, if Label# is 00210034, then description 21 will be pulled from the description table and description 34 will be pulled from the description table. If 21 is BL* and 34 is TC, then the resulting description will be BL* TC.
3) Point numbers are taken from measurement records. A measurement record will follow code 10, 20, 30, and 40 records. For example: In this example, there is a side-shot record (40), a point label description (71), a rod height (2.150), and a point number (332).
4) If an offset distance is placed in Field 3 of a side-shot record, the measured angle will be shown in a comment line prior to the data record with the newly calculated angle.
5) If a comment is placed in field 4 of a side-shot record, the comment will be appended to the point's description. example: If the label# is 25 and the comment is 150, description 25 (lets say TREE) will be pulled from the description table and the comment will be appended to the description, giving TREE 150 as the description.

Leica Data Pro:

You are allowed to read and write to the Leica Data Pro formatted GSI files. There is no communication directly with the Leica Total stations.

GEODAT 122/124 DATA COLLECTOR

In order to use the Geodat 122 or 124 data collector with the transfer program, there are three areas that you
must consider: (1) entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, and (3) the data collector code conversion table which converts numeric codes to more readable descriptions when the data is sent to the computer. The following section describes how to enter your data into the data collector. The next section will then give you some information about how to transfer the data. The data collector code conversion table can be changed with menu selection E from the program menu.

### Entering Data into the Data Collector

1) Each individual job stored in the Geodat's memory should begin with a job identifier. To enter a job identifier, follow these steps:

   a) Press the `<Info>` key.
   b) At the prompt "inFo=" enter a job number, like this: inFo=87001<Ent> (<Ent> means to press the <Ent> key.)
   c) At the prompt "dAtA=" enter the date like this: Example: dAtA=050187<Ent> (for 05/01/87)

2) For each instrument location, you must enter an instrument point identifier.
   Follow the following steps to do this:
   a) Press the `<Stn>` key.
   b) At the "Stn=" prompt enter you instrument point number like this: Stn=1<Ent> (for instrument point 1)
   c) At the "iH=" prompt enter the instrument height, like this: iH=5.5<Ent> (for 5.5 feet)
   d) Next the prompt "PCod=" will appear on the display. At this time, enter your backsight point, just like the foresights in the next step. You may enter "0" (zero) for all of the fields except: "Pno=" (enter the backsight point number)
      "Hor=" (enter the angle in your instrument when you take the backsight.)

3) Recording foresights. You are now ready to record a foresight:
   a) At the "PCod=" prompt enter the point code for your foresight like this: PCod=10<Ent> (for point code 10)
   Note: The point code will be used to assign a description to your foresight. The description that is associated with each code is up to you. Use the "Edit data collector code table" program to set up your codes before uploading your data to the computer.
   b) At the "Pno=" prompt enter your foresight point number like this: Pno=2<Ent> (for point number 2)
   c) At the "SH=" prompt enter the rod height of your foresight like this: SH=5.5<Ent> (for 5.5 feet)

The next three fields may be entered manually or may be automatically stored by your instrument.
   d) At the "Hor=" prompt enter the horizontal angle to your foresight like this: Hor=65.1253<Ent> (for 65 degrees, 12 minutes, and 53 seconds.)
   e) At the "ELE=" prompt enter the vertical angle to your foresight like this: ELE=90.1215<Ent> (for 90 degrees, 12 minutes and 15 seconds)
   f) At the "diSt=" prompt enter the slope distance to your foresight like this: diSt=100.128<Ent> (for 100.128 feet)

Now, go to step 2 for a new instrument point, or step 3 for another sight from the current instrument point.

Note: If you have already dumped the data stored on the 122/124 to a computer file (in the 122/124 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

### Receive Data from Data Collector

Select the receive raw data option.

1) Before you upload your data, make sure that the description table is current.
2) Before you initiate the upload program, you must first define the upload parameters for the Geodat. To do this, follow the steps outlined below.

3) This should not have to be done each time. The values that you enter should stay the same until you change them.

   a) Press the <f>, the <1>, the <0> and the <Ent> keys. (For function 10.)
   b) Answer the baud rate question like this: bAud=1200<Ent> (for 1200 baud you can use 300 baud, but it will take longer to transfer your data.)
   c) Make sure that "Eob=" looks like this: Eob=0123456789<Ent>
   d) Make sure that the "StArt=" prompt looks like this: StArt=035<Ent>
   e) Make sure that the "StoP=" prompt looks like this: StoP=000<Ent>
   f) Make sure that the "ErrCodE=" prompt looks like this: ErrCodE=037<Ent>
   g) Make sure that the "nuLLS=" prompt looks like this: nuLLS=000<Ent>

GEODAT 126, 400, 500 AND INTERNAL MEMORY THEODOLITES

These Geodat data collectors use the following data entry format:

Instrument Point Setup
Labels Explanation
2 Instrument Point
3 Height of Instrument
62 Backsight Point
21 Backsight Angle
6 Backsight Rod Height
7 Horizontal Angle to Backsight
8 Vertical Angle to Backsight
9 Slope Distance to Backsight
* Indicates required code

Note: Pcodes (label 4) cannot be used anywhere except in foresight records.

Note: The order of the instrument point setups is not important.

Foresight Points
Labels Explanatation
5 Foresight point
6 Backsight rod height
7 Horizontal angle to backsight
8 Vertical angle to backsight
9 Slope distance to backsight
4 Pcode (Description)
* Indicates required code

Note: Foresight points must begin with either a Pcode (label) or a foresight point (code 5). The order of the remaining parameters is not important.

Label 4 (Pcodes) are placed in the description field of the raw data file. If you cannot get the entire point description into a single Pcode, we allow you to use multiple Pcodes for an individual point.

Example: 4 = Manhole,
4 = Inv. -10.23,
4 = 12’’ Conc.Pipe
The resulting point description is: Manhole, Inv. - 10.23, 12" Conc.Pipe If the Append Info Records to Pcode toggle is on, info records (label 0=) that directly follow a Pcode (label 4=) will be appended to the Pcode prior to being placed in the point description.

Example: 4 = Manhole, 0 = Inv. -10.23, 0 = 12" Conc.Pipe
The resulting point description is: Manhole, Inv. - 10.23, 12" Conc.Pipe

GEODAT 126 DATA COLLECTOR

I. The Cable

Your cable should be made as follows:
NC - No connection.

Geodat 126 (male)Computer 25 Pin
2 .......................................... 2 (TxD)
3 .......................................... 3 (RxD)
7 .......................................... 7 (S.GND)
5-NC —-5 (CTS) jumper 5-6-8-20
6-NC —-6 (DSR)
8-NC —-8 (CD)
20-NC —-20 (DTR)

Geodat 126 (male)Computer 9 Pin
2 .......................................... 3 (TxD)
3 .......................................... 2 (RxD)
7 .......................................... 5 (S.GND)
5-NC —-8 (CTS) jumper 8-6-1-4
6-NC —-6 (DSR)
8-NC —-1 (CD)
20-NC —-4 (DTR)

II. Set Protocol 2 and 5; Set Format 2

Be sure the INT./EXT. switch is set to INT. if you are not connected to an external power source. Be sure the on/off switch is in the on position.

Set protocol by using program 51 in the Geodat.
Protocol 2 Protocol 5
1: 9600 1: 9600
2: 2 2: 2
3: 7 3: 7
4: 2 4: 2
5: 10 5: 10
6: 0 6: 0
7: 0 7: 0
8: 0 8: 0
9: 0 9: 0
10: 0 10: 0
11: 0 11: 0
Set format by using program 50 in the Geodat.

Format 2
1: 1
2: 80
3: 13
4: 15

III. Data Storage in the Geodat 126

Raw data is gathered into job files using the pre-programmed UDS's in the Geodat 126. Call us if you wish to create others.

To use the existing programs, begin by choosing program #10. This sets up the header information and first instrument/back sight points. For foresights, choose program #0 if you are carrying elevations or program #1 for horizontal locations only. Use program #11 to change instrument set-ups. These programs are explained on page 8:4 in the Geodat manual.

Coordinates are transferred from and into area files.

Special numeric point codes may be used. These codes are converted to alphanumeric descriptions as the data is received from the Geodat 126. The codes are defined in the description table.

IV. UDS Requirements

The initial testing of the Geodat 126 was done using the standard UDS's supplied with the Geodat 126. If you wish to try using your own, these rules apply:

1) A measurement must end with label 9. (See sample UDS's 0, 1, 2, 3.)
2) Each Job. No. file must begin (1st record) with ADM type data (see sample UDS 10). This sequence must end with label type 74 - Air Pressure.
3) Each instrument station sequence must end with Hz. Ref. (Label 21). See the UDS 11 in Geodat 126 manual for sample.

Select the receive/send option from the computer menu and follow the prompts. If you have already dumped the data stored on the DR-2 to a computer file (in the DR-2 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

GEODAT 400 DATA COLLECTOR

Setting up the Geodat 400 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).

Be sure the on/off switch is in the on position. Set protocol by using program 51 in the Geodat field instru
Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 400 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.

Set format by using program 50 in the Geodat field instrument.
Format 0
1: 1
2: 80
3: 324:
4 *

Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 400 Data Recorder.

If you have already dumped the data stored on the 400 to a computer file (in the 400 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

Uploading Raw Data to the Computer

After you have collected your field data, connect the Geodat 400 to your computer. Select the receive raw data option. The baud rate in the computer must match the baud rate in the Geodat 400. Do the following:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat job file.

Download Coordinates into 400 Area File

Select the send coordinates option.
Select the points to send.
Ready the 400 with the following steps:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The coordinates will be transferred.
Get Coordinates from 400 Area File

Receive coordinates from 400 Area File

The baud rate in the computer must match the baud rate in the 400. Do the following:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The transmission will begin.

GEODAT 500 DATA COLLECTOR

Setting up the Geodat 500 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).
Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 500 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking. Set format by using program 50 in the Geodat field instrument.

Format 0
Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 500 Data Recorder.

The C&G Data collector Transfer dialog box has an additional option for the GEODAT 500 collector, as shown below. the show DC files:

![C&G Data Collector Transfer](image)

This Option actually reads and displays the data files on the GEODAT 500 data collector. From the display options you can select to view all files, just coordinate files or just raw files.

If you have already dumped the data stored on the 500 to a computer file (in the 500 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

You can also delete files from the GEODAT 500. Be careful, once the files is deleted it is gone forever. When you have the files selected, you want to transfer, select exit.
The Geodat 500 program allows:
1) Receive raw data from the Geo 500
2) Receive raw data from a file.
3) Receive coordinates from the Geo 500.
4) Receive coordinates from a file.
5) Send coordinates to the Geo 500.
6) Catalog (or directory) of all files on Geo 500.
7) Delete files on the Geo 500.

Receiving Data from the 500

You may receive raw data files (M=), or coordinate files (I=). All files on the 500 of the type you wish to receive will be shown on the screen (for example, all I= files for coordinate).
1) Select the file you wish to receive. Raw Data (Job Files)

2) After the raw data file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with a .CGR extension. Coordinates (Area Files)

3) After the coordinate file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with .CRD/.IDX extensions.

Sending Data to the 500

You may send coordinate (.CRD) files to the 500. All coordinate files on the computer will be shown on the screen. Select the file you wish to send.
1) You may select the only the coordinates that you wish to send (you do not have to send the entire file). Catalog
2) The catalog function will show you all existing files on the Geodat 500.

Deleting Files
All files on the 500 will be shown on the screen.
1) Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
2) Press <Esc> if you do not want to delete a file.

GEODIMETER TOTAL STATIONS WITH INTERNAL MEMORY

You can select Geodat 500 and interface directly with any Geodimeter that has internal memory. To transfer data from a Geodimeter Total Station with internal memory, do the following:
1) In Equipment Options, select Geodat 500 as the data collector and run data collection program.
2) Use Geotronix cable #571136756. Connect RS232 on computer to RS232 on Geodimeter with cable.
3) Power on Geodimeter and turn off compensator with Function 22 as follows:
   Key
   <F> (Function)
   <22>
   <Ent> (Enter)
   <0>
   <Ent>
   Then press <Ent> until P0 is displayed on Geodimeter screen.

4) Set the END character to 4 with Function 79 as follows:
   Key
   <F> (Function)
   <79>
   <Ent> (Enter)
   <4>
   <Ent>
5) Initiate comm port on Geodimeter as follows:
   Key
   <Mnu> (menu)
   <4> (data com)
   <1> (select device)
   <2> (serial)
   <Yes> (serial on)
   <1.8.0.9600> (com=) skip if already set
   <Ent> (enter)
   <0> (table no=)
   <Ent>
   <No> (REG. key?)
   <No> (Slave ?)
6) You may now select all options on the computer menu for data collection transfer with the Geodimeter. See Geodat 500 instructions for data transfer (disregard formatting procedures).

SMI 48 ENHANCED DATA COLLECTOR

The SMI interface routine works only with SMI Enhanced Cards. Use the interface cable supplied with the SMI unit (plugs into the comm port on the computer).

SMI 48 transfer Versions 5

Receiving Data

Chapter 4. CGSurvey Module
If you have already dumped the data stored on the SMI to a file on the computer, you may choose to receive the data from the file.

Receiving Raw Data from the SMI

Select the Receive raw data option on the computer. On the SMI, select TOPC and then RAW. The transfer will begin. The file name will be shown on the screen after the transfer is complete. You may enter a new file name if you wish. Our reduction program does not allow a raw data file with mixed angle types (for example: azimuths, angles right, deflections, etc.). When you are collecting data on the SMI, stick to one angle type. You can mix distance types if you wish (slope/zenith, horizontal/vertical).

Receiving Coordinates from the SMI
1) **Select the Receive Coordinates option on the computer**: On the SMI select TOPC and then SMI.
2) **On the SMI, enter the first and last point numbers you wish to send**: The transfer will begin.

 Sending Coordinates to the SMI

1) **On the SMI select TD48 and the SMI.**
2) **Select the Send Coordinates option on the computer.** You will be asked if you wish to send descriptions.
The answer to this question depends on whether the SMI coordinate file you are sending to is a 15 byte file (no descriptions) or a 30 byte file (descriptions).

3) On the computer, select the points you wish to send. When the selection set is complete, press <T> for transmit. The transfer will begin.

**SMI 48 transfer Versions 6, 7 & 8**

**Receiving Raw Data from the SMI**

1) Get the C&G Transfer Program ready to receive raw data: Press Transfer
2) On the SMI data Collector select [PRINT]: set the soft-key to [WIRE]

**Receiving Coordinates from the SMI**

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the SMI data Collector select [JOB], then [KERM]: set the soft-key to [NE] and [COMM]. select [SEND] and then select the points to transfer.

**Sending Coordinates to the SMI**

1) On the SMI data collector select [JOB] the [KERM]: set the soft-key to [NE] and [COMM]. select [RECV].
2) Configure the C&G Transfer Program to send Coordinates: select the points to be sent and press TRANSFER

**Nikon Data Collection Transfer**
Receiving Raw Data from the Nikon Total Station:

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: RAW
4) Press ENTER to send.

Receiving Coordinates Data from the Nikon Total Station

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: COORD.
4) Press ENTER to send.

Sending Coordinates Data from the Nikon Total Station

1) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
2) From the Main Menu on the Nikon: select "Comms" and "Upload Data". Press ENTER to receive.
3) Configure the C&G Transfer Program to Send Coordinates: select the points to be sent and press TRANSFER.
   Pulldown Menu Location: CG-Survey>CGTrav>Data Collector Transfer
   Keyboard Command: DC, CG_DATA_COLLECTOR
   Prerequisite: Check Cable Connection & Communication Parameters

Reduce Traverse

The Reduce Traverse feature allows you to reduce a raw data file, with or without adjustment, and thus create a coordinate file or append to an existing coordinate file.

NOTE: Before you reduce a traverse, check the traverse settings on the Traverse Options tab of the C&G Options dialog.

Select the type of adjustment to use: (Compass, Least Squares, etc..)
Adjust Angles: (off/on)
Balance Elevations: (off/on)
If you are adjusting a 3-D traverse, make sure Elevations are turned on: ON
Once the traverse options are set properly you can proceed with traverse reduction.
Select Reduce Traverse from the CGTrav menu.

If a raw data file is already open, it will be used. If not, a dialog box will appear prompting you to open a raw data file.

If a coordinate is already open it will be used. If one is not opened you will be prompted to open one. You can select an existing file or type in the name of a new file to create.

**NOTE:** One coordinate file may be used with many raw data files. For example, you may store the coordinates reduced from an initial boundary traverse (raw data file) in a newly created coordinate file. If you do additional location or traverse work with the control created by the original traverse, this additional work may be placed in new raw data files and reduced to the same coordinate file.

If the raw data file does not have traverse codes (see the CGEditor chapter) a dialog will appear asking you which type to use. There are three types of traverses that can be processed. These are shown in the following figure:

The following figures show examples of the three traverse types. The H.I. and rod height entries are optional (if Elevation are on). These are examples of a single distance/angle entry. Each type traverse may be placed in a separate raw data file and reduced into a single coordinate file. However, with the use of special codes you can combine traverses in a single raw data file (See the CGEditor chapter).

**Traverse Reduction Types:**

**Closed Loop Traverse**
Closed Loop Traverse Beginning and Ending at Known points

Shows above is closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.
Closed Loop Ending on One Known Point

### Table:

<table>
<thead>
<tr>
<th>Inst Point</th>
<th>Inst Point</th>
<th>Backsight</th>
<th>Rod Height</th>
<th>H Hor. Angle</th>
<th>H Slope Dist</th>
<th>V Vert. Angle</th>
<th>Foresight</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>2</td>
<td>1</td>
<td>200000</td>
<td>0.00000</td>
<td>131.20000</td>
<td>90.20000</td>
<td>7</td>
<td>TP</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>FS</td>
<td>7</td>
<td>2</td>
<td>0.00000</td>
<td>100.11150</td>
<td>164.12000</td>
<td>88.20200</td>
<td>7</td>
<td>TP</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>IP</td>
<td>8</td>
<td>1</td>
<td>0.00000</td>
<td>217.40500</td>
<td>193.51000</td>
<td>90.50000</td>
<td>8</td>
<td>TP</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>FS</td>
<td>8</td>
<td>2</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>8</td>
<td>TP</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>IP</td>
<td>4</td>
<td>3</td>
<td>0.00000</td>
<td>182.14000</td>
<td>191.57000</td>
<td>92.03140</td>
<td>4</td>
<td>TP</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>8</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>8</td>
<td>TP</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>5</td>
<td>0.00000</td>
<td>62.651000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>5</td>
<td>TP</td>
<td>IPF</td>
</tr>
</tbody>
</table>
Shown above is a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point.

This situation sometimes occurs when you begin on two known points (or a single known point and a back sight azimuth) and end on one known point. In this case only a linear closure is possible.

In order to reduce this type of traverse you must use the CGEditor to enter data not gathered in the field.

Points 2 and 4 are the known beginning and ending points.

Points 100 and 101 do not exist.

We have entered a back sight reference bearing (N 25° 23' 25" E) from 2 to 100.

Line 8 is a dummy setup (we never setup on point 4 and back sighted point 8.

Line 9 shows a dummy angle to the dummy point 101.

Reduce the traverse as a closed Traverse Beginning and Ending on Known Points.

When the traverse is reduced you will have to enter one of the following:

The coordinates of point 101

The bearing from point 4 to 101. Or press <esc> for no angular closure.

If you choose no angular closure, the traverse will be reduced but will report only a linear closure. The adjustment will be made assuming no angular error.

**Open Traverse**
An Open Traverse is either an open ended traverse which ties into no known points or a file containing only side shots. In both cases no adjustment is possible.

Note: The data shown in the CGEditor views accompanying the four illustrations include instrument height (HI) and rod height entries. However, if you have elevations turned off, these entries are optional. Also, the examples use single distance and angle entries but multiple measurements are allowed.

In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

Notes on Traverse Types and Reduction

Closed and Azimuth Traverses: If you are running azimuth traverses, the angle to the side shot is calculated and stored instead of the azimuth. After the traverse has been reduced and adjusted, the angles are used to calculate the side shot coordinates. Thus the side shots are always relative to the instrument point and backsight point used in their location. The first azimuth in the raw data file will be considered a reference azimuth and will be held.

Reducing Loop Traverses:

If there is at least one reference bearing in the raw data file being reduced you will not be asked for a starting bearing. If the instrument point coordinates at the first reference bearing exists, you will not be asked to enter the starting coordinates or elevation. The traverse reduction will begin from the first reference bearing in the raw data file, not necessarily the first instrument point.

If you have more than one reference bearing in the raw data file, the angular closure and adjustments will be from one reference bearing to the next. In other words, all reference bearings will be held as correct, and any angle adjustment will be done from one to the next. This feature was designed for those surveyors who perform...
Solar or Polaris observations at intermediate traverse stations, and wish to hold the observed bearing at those stations (the bearings will of course change when the coordinates are adjusted, unless you use Crandall's Rule which does not change bearings).

**Reducing Open Traverse:**

Any Reference Bearings found in the raw data file for an Open traverse will be ignored (except the starting reference bearing/azimuth to the back sight point).

**Traverse Reduction: Closed Loop**

If the first instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point. If the first back sight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the back sight point in the raw data file, you will be given the choice of entering one of the following:

- **Back sight point coordinates**
- **Bearing from the first instrument point to the first back sight point**

If you are processing a Closed Traverse that Begins and Ends on known points, and the last (tie) instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point. If the last foresight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the foresight point in the raw data file, you will be given the choice of entering one of the following:

- **Foresight point coordinates**
- **Bearing from the last instrument point to the last foresight point** (the last instrument and foresight point are the tie points necessary for linear and angular closure calculations).

**Note:** The bearing from the first instrument point to the first back sight point, and the bearing from the last (or tie) instrument point to the last (or tie) foresight point will be treated as reference bearings (held fixed). These four points will not be adjusted. If there are any reference bearings in the raw data file, the angular closure and adjustments will be from one reference bearing to the next, just as in Loop Traverses.

Since you may have many foresights from the instrument tie point (side shots), you will be asked to enter which foresight point you will be tying into (unless there are no side shots at the last instrument point).

The traverse will begin by the coordinates found in the coordinate file for the first instrument point and backsight point (coordinate values can be placed directly into the raw data file). The traverse will then be calculated. When the traverse is finished, the coordinates for the last instrument point and foresight point in the raw data file will be read from the coordinate file (or raw data file) in order to calculate the angular, vertical and horizontal closure.

If Elevations are ON you will be shown the elevation control found in the Raw Data and Coordinate files that pertains to your traverse. If no elevation control is found none will be shown and you will have to ADD control.
Your elevation control can be anywhere in the traverse. It does not have to be on the first point.

You will have the following option at the command line:
Point Elevation
1 500.00
[Add/Change/Delete/Go/aBort]: <G>g

Select Add to add points to elevation control: A
Select Change to change the elevation assigned to a point in the elevation control: C
Select Delete to remove a point from the elevation control: D
Select Go to calculate elevations: G
Select aBort to quit without calculating elevations B

Select the appropriate option and the elevations will be calculated based upon the supplied information.

At this point you will get two closure reports:

The first report is before angle adjustment:

********** Closure Report **********
Total angular error: -0°00'06"
Angular error per point: -0°00'01"
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04008 East: 5000.00421
Error, N: 0.04 E: 0.00 Total: 0.04 Brg: S 05°59'43"W
Distance Traversed: 2470.51 Closure: 61308

The Second Report is after angle adjustment:

********** Closure Report **********
Total angular error: 0°00'00"
Angular error per point: 0°00'00"
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04314 East: 5000.01593
Error, N: 0.04 E: 0.02 Total: 0.05 Brg: S 20°16'08"W
Distance Traversed: 2470.51 Closure: 53721

Following the angular adjustment the reduced traverse will be displayed:

Adjusted by Least Squares
Bearing Distance Northing Easting Elevation Pt ID Code Description
5000.00000 5000.00000 500.00 1 1 TP1 2
N 00°00'00"E 242.12 5242.12397 5000.00000 496.39 2 1 tpsns
N 74°41'24"E 199.78 5294.87495 5192.69243 467.97 3 1 tpsns
N 00°22'42"W 148.48 5443.34679 5191.71202 460.90 4 1 tpsns
N 04°35'35"W 310.32 5752.67444 5191.71202 460.90 5 1 tpsns
S 83°11'32"W 300.98 5716.99780 4868.00744 473.72 6 1 tpsns
S 84°09'21"W 290.03 5687.46658 4579.48877 472.10 7 1 tp hole
S 13°25'02"E 137.70 5553.52582 4611.44085 484.33 8 1 tpsns
S 05°29'41"E 234.70 5319.90709 4633.91387 501.54 9 1 tpsns
S 12°52'27"E 308.42 5019.23837 4702.63376 517.34 10 1 tpsns
Once the traverse is reduced the side shots will be computed and displayed:

<table>
<thead>
<tr>
<th>Inst.Pt.</th>
<th>Bs.Pt.</th>
<th>Angle</th>
<th>Distance</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Pt ID Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10</td>
<td>148°15'53''</td>
<td>123.43</td>
<td>5058.01266</td>
<td>5108.95161</td>
<td>489.96</td>
<td>47</td>
<td>ipf1otp</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>97°53'24''</td>
<td>46.81</td>
<td>5045.85154</td>
<td>5009.40500</td>
<td>499.25</td>
<td>48</td>
<td>ipf4rb</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>17°33'40''</td>
<td>96.60</td>
<td>5035.03240</td>
<td>4909.97367</td>
<td>506.27</td>
<td>49</td>
<td>ipf4rb</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>255°33'17''</td>
<td>93.22</td>
<td>5265.37939</td>
<td>5090.27763</td>
<td>480.73</td>
<td>25</td>
<td>ipf1\2' ctp</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>146°29'54''</td>
<td>17.38</td>
<td>5256.61928</td>
<td>4990.40516</td>
<td>500.49</td>
<td>26</td>
<td>ipf1\2' ctp</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>297°01'47''</td>
<td>18.33</td>
<td>5276.92239</td>
<td>5188.96820</td>
<td>468.73</td>
<td>27</td>
<td>ipf1#ctp</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>10°21'19''</td>
<td>65.64</td>
<td>5378.69600</td>
<td>5180.33917</td>
<td>466.55</td>
<td>28</td>
<td>ipf1ctp</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>159°23'20''</td>
<td>63.27</td>
<td>5502.41856</td>
<td>5169.04898</td>
<td>461.70</td>
<td>29</td>
<td>ipf1otp</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>113°52'33''</td>
<td>138.30</td>
<td>5498.48975</td>
<td>5064.87673</td>
<td>483.03</td>
<td>30</td>
<td>ipf1\2' ctp</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>113°47'52''</td>
<td>186.84</td>
<td>5517.60975</td>
<td>5020.26008</td>
<td>489.30</td>
<td>31</td>
<td>9 fly</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>291°56'23''</td>
<td>100.21</td>
<td>5406.52118</td>
<td>5284.90634</td>
<td>455.81</td>
<td>32</td>
<td>9 fly</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>299°04'02''</td>
<td>111.18</td>
<td>5389.97593</td>
<td>5289.24079</td>
<td>455.88</td>
<td>33</td>
<td>4 ipf1ctp</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>39°33'59''</td>
<td>47.28</td>
<td>5713.93615</td>
<td>5139.76338</td>
<td>458.30</td>
<td>34</td>
<td>4 ipf1ctp</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>260°33'36''</td>
<td>119.08</td>
<td>5781.54910</td>
<td>5282.38627</td>
<td>464.12</td>
<td>35</td>
<td>2 ipf4rb</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>72°51'12''</td>
<td>136.19</td>
<td>5702.23225</td>
<td>5040.36168</td>
<td>469.98</td>
<td>36</td>
<td>4 ipf1\2ctp</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>32°47'04''</td>
<td>103.73</td>
<td>5651.38227</td>
<td>4645.83837</td>
<td>475.70</td>
<td>37</td>
<td>9 nf</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>150°46'50''</td>
<td>209.58</td>
<td>5399.34540</td>
<td>4753.39990</td>
<td>512.22</td>
<td>38</td>
<td>9 fly</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>104°48'11''</td>
<td>144.87</td>
<td>5550.02257</td>
<td>4756.26507</td>
<td>497.59</td>
<td>39</td>
<td>9 fly</td>
</tr>
<tr>
<td>7</td>
<td>9</td>
<td>156°21'56''</td>
<td>66.78</td>
<td>4965.56171</td>
<td>4742.36495</td>
<td>517.21</td>
<td>46</td>
<td>9 stk</td>
</tr>
</tbody>
</table>

********** Elevation Calculations - Elevations Adjusted **********

Elevations from Points: 1 -> 1
Vertical Err: -0.01, Distance Traversed: 2470.51

The calculate points will be stored in the coordinate file. There is an overwrite protection built into the software. If a point already exists in the coordinate file you will have the following options:
CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NOT OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRITE will overwrite all points without asking.
DO NOT OVERWRITE: will only write NEW points to the coordinate file.

Traverse Reduction: Open Traverse/Side Shots

When reducing these types of traverses, no adjustments are possible. The coordinates for instrument points and back sight points will be pulled from the coordinate file (or raw data file) and used to calculate and store the foresights. This option allows you to occupy newly created points.

Coordinates of back sight points will be calculated only if a distance has been entered to the back sight point and the back sight point does not exist in the coordinate file.

If you are back sighting a point that does not exist in the coordinate file and the raw data file does not contain a reference bearing or azimuth to the back sight point, you will be given the choice of entering one of the following:

Coordinates of the back sight point
Bearing from the instrument point to the back sight point

If you choose to enter the bearing and there is no distance to the back sight point in the raw data file (thus making it impossible to calculate its coordinates), and you later occupy that point, you will be asked to enter the real coordinates of the point.

If you are backsighting a point that does exist, and you have a distance measurement to the backsight point in the raw data file, we will show a warning if the inversed distance from the coordinate file does not match the measured distance within the tolerances set in the CGTools->Global Options->Traverse Options dialog.

A table will be printed containing the following:
Angle Adjustments

If you have set Adjust Angles in the Traverse Options dialog box, all angles will receive equal adjustment. If there is more than one reference bearing, the angles will be adjusted equally between reference bearings. You will be shown the closures before and after the angle adjustment.

**NOTE:** If you are going to use the Least Squares Adjustment, you should not adjust the angles. Angular adjustment is part of the Least Squares Adjustment process.

Elevation Adjustment

If you have set Adjust Elevations in the Traverse Options dialog box, the elevations will be adjusted in proportion to the lengths of the lines (the longer the line, the more the adjustment).

Least Squares, Crandall's and Compass Rule

If you select any of these adjustment options the coordinates will be adjusted with the appropriate method.

Find Bad Angle

If you have a bad angular closure, select Find Bad Angle in the Traverse Options dialog box instead of an adjustment type. This function will not create or store any coordinate points.

**NOTE:** This option cannot be used with Azimuth Traverses.

You will see the following report:

Total angular error: 0°00'07"
Angular error per point: 0°00'01"
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 10000.05876 East: 9999.95840
Error, N: 0.05876 E: -0.04160 Total: 0.07200 Brg: S 35°17'49"E
Distance Traversed: 1492.10800 Closure: 20725

Instrument point: 1, Error: 0.07200, Closure: 20725
Instrument point: 2, Error: 0.08249, Closure: 18089
Instrument point: 3, Error: 0.08284, Closure: 18013
Instrument point: 4, Error: 0.07542, Closure: 19785
Instrument point: 5, Error: 0.06751, Closure: 22103
Worst Closure: 18013
Average Closure: 19620
Possible bad angle at instrument point: 5, Closure: 22103

In the above example, there were 5 traverse points. The traverse is reduced five times, beginning at each traverse point. The starting instrument point that produces the best closure is shown as having the bad angle. All closures are shown.

**OTHER METHODS OF TRAVERSING**
Every surveyor has his own unique methods when it comes to traversing. This section describes and shows examples of four additional entry methods.

Notice in the sample traverses there is a distance and vertical angle recorded for each foresight and back sight. This is optional, but you need at least one distance to each foresight.

Where both foresight and back sight distances are recorded, distances will be averaged when reduced.

Side shots may be entered along with traverse information. You may turn more than one angle to side shots if you wish.

A description and/or code only needs to be entered once for a given foresight point.

**Single Position with Direct and Reverse Angles**

Perform this method as follows:

- Shoot the back sight.
- Turn to a foresight.
- Record the angle and distance.
- Plunge the instrument.
- Take another reading (reversed) to the foresight. You may do this to traverse points and side shots.
- Turn back to the back sight with the instrument reversed.
- Record another angle to the back sight.

The final angle in each set for each instrument point must be a reverse reading to the back sight.

The angle in the instrument for the first back sight will be subtracted from the first angle to each foresight. The final (reverse) angle to the back sight will be subtracted from the second angle to each foresight. The two resulting angles will then be averaged to give you an angle to the foresight. All distances recorded will be averaged.

---

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>IP 1</td>
<td>5.320000 5</td>
<td>5.00000</td>
<td>0.00000</td>
<td>290.54000</td>
<td>08.35000</td>
<td>2</td>
<td>H&amp;T</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 2</td>
<td>5.00000</td>
<td>109.19170</td>
<td>292.31000</td>
<td>88.35000</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 3</td>
<td>5.00000</td>
<td>289.19230</td>
<td>292.31000</td>
<td>271.25100</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 4</td>
<td>5.00000</td>
<td>190.32100</td>
<td>52.39000</td>
<td>90.52560</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 5</td>
<td>5.00000</td>
<td>19.32100</td>
<td>52.39000</td>
<td>269.27900</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 6</td>
<td>5.00000</td>
<td>180.00020</td>
<td>290.54000</td>
<td>271.25100</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS 7</td>
<td>5.00000</td>
<td>90.00000</td>
<td>6</td>
<td>Single Positions with Multiple Direct and Reverse Angles</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Chapter 4. CGSurvey Module
Entering multiple sets of direct and reverse angles is very much like the preceding example where 1 direct and reverse set was entered. The only thing to remember is that each direct and reverse pair is a set. When another set is entered, it begins with a back sight direct angle (recorded like a foresight), has direct angles and reverse angles to the foresights, and ends with a reverse angle to the back sight. Do not begin a new instrument point for the second set, merely record a new back sight angle and continue with the procedure through each foresight, and end with another reverse angle to your back sight.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BP</td>
<td>1</td>
<td>5.37000</td>
<td>5</td>
<td>5.80000</td>
<td>0.00000</td>
<td>290.54000</td>
</tr>
<tr>
<td>FS</td>
<td>2</td>
<td>5.80000</td>
<td>10.19100</td>
<td>297.31000</td>
<td>80.35000</td>
<td>2</td>
</tr>
<tr>
<td>BP</td>
<td>3</td>
<td>5.40000</td>
<td>1</td>
<td>5.80000</td>
<td>0.00000</td>
<td>282.31000</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>5.80000</td>
<td>104.27400</td>
<td>275.84000</td>
<td>87.37000</td>
<td>4</td>
</tr>
<tr>
<td>BP</td>
<td>5</td>
<td>5.80000</td>
<td>180.00000</td>
<td>290.54000</td>
<td>80.35000</td>
<td>5</td>
</tr>
</tbody>
</table>

Azimuths are entered into a file with the azimuth to each foresight entered in the Foresight data entry line at the azimuth column.

NOTE: If you are running a Closed Loop Traverse, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

The reference azimuth is the correct azimuth from the last instrument point in the raw data file to the first instrument point (or last foresight).

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BP</td>
<td>1</td>
<td>5.37000</td>
<td>5</td>
<td>5.80000</td>
<td>0.00000</td>
<td>290.54000</td>
</tr>
<tr>
<td>FS</td>
<td>2</td>
<td>5.80000</td>
<td>10.19100</td>
<td>297.31000</td>
<td>80.35000</td>
<td>2</td>
</tr>
<tr>
<td>BP</td>
<td>3</td>
<td>5.40000</td>
<td>1</td>
<td>5.80000</td>
<td>0.00000</td>
<td>282.31000</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>5.80000</td>
<td>104.27400</td>
<td>275.84000</td>
<td>87.37000</td>
<td>4</td>
</tr>
</tbody>
</table>

Traverse with Doubled Angles

Chapter 4. CGSurvey Module 857
Each new instrument setup requires a 0 to the back sight. The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken. The second angle to the foresight is the doubled angle. You can double angles to side shots.

Loop Traverse Beginning and Ending on External Reference Azimuths

This type of traverse occurs frequently. The example below shows a Loop Traverse that begins on an external reference azimuth and ends on an external reference azimuth. Even though this traverse closes on itself, it must be reduced as a Closed Traverse Beginning and Ending at Known Points.

Point 100 is a dummy point on the azimuth line. Line 3 shows a reference bearing from point 1 to 100 (negative means from ip to bs) of S00-00-00E.

Line 16 shows the same reference bearing.

Point number 100 need not exist in the coordinate file and will not be calculated, but a dummy backsight and foresight point number must be entered into the raw data file.

Use Of Reference Bearings and Azimuths

Reference Bearings and Azimuths are entered by Adding or Inserting a Reference Bearing data entry line. For example:

DR 1-2 123.4523

The direction from point 1 to point 2 is N23-45-23E.

Reference bearings and azimuths are optional (except for Closed Loop Azimuth Traverses). If a reference bearing is used, that direction will be held during the reduction process. More than one reference bearing may be used. The data below shows a raw data file using multiple reference bearings:

The previous data represents a loop traverse. If you choose to adjust angles, all angles will be adjusted from one reference bearing to the next (angles 1-5, 6-1). Angular closure information will also be shown from one reference bearing to the next. See the Reduction section of this chapter for more specific information on the use of reference bearings with different types of traverses.

Except for an initial reference bearing to the back sight point, reference bearings will be ignored for Open Traverses (no adjustments are available).
Multiple Traverse Codes in a Single File

This sample is of a raw data file that contains multiple traverse codes in a single file: ET end main loop traverse
Scale factors are placed after Instrument Point data entry lines. Any text following a LT, CT, OT or ET marker is used for comments. Notice that the codes MUST precede the first instrument setup that begins the traverse.
The Foresight Tie Point in the previous example is necessary because there is a side shot (point #25) at the end of the Closed Traverse. The reduction routine does not know whether you are tying into point 25 or point 2.

Pull Down Menu Location: CGTrav \ Reduce Traverse
Keyboard Command: RT, CG_REDUCE_RAW
Prerequisite: Open Raw file *.CGR

Edit Map Check File

The map check program is used to enter or edit deed and map information for checking closures and to assist with evaluating data from other sources for a job you are working on.

Note: for further and complete information on using the Mapcheck editor, see the chapter on CGEditor in the Tools section.

Pulldown Menu Location: CGTrav/Edit Mapcheck File
Keyboard Command: EM, CG_EDIT_MAP
Prerequisite: None

Reduce Map Check File

If a map check file is not open, a file dialogue box will appear, allowing you to open an existing map check file. If you wish the coordinates to be adjusted, select the type of adjustment in the Traverse Options dialog box. If a coordinate file is not open, a file dialog box will appear allowing you to open one. NOTE You may use the same

Chapter 4. CGSurvey Module 859
coordinate file as often as you wish. Make sure the correct coordinate file is open.

**Next Enter Point values:** the starting Point number, Northing and Easting and the ending Northing and Easting:

![CGSurvey for AutoCAD - Reduce Map Check File](image)

The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:

![Point Overwrite](image)

**CANCEL:** will terminate the process of storing coordinates.

**OVERWRITE:** will overwrite the existing point.

**DO NOT OVERWRITE:** skip to the next point. If you have the "Do Not Ask Again" box checked.

Overwrite will overwrite all points without asking, and Do Not Overwrite will only write NEW points to the coordinate file.

The initial closure information will be shown. For example:

Correct Ending Coordinates, North: 5000.0000 East: 5000.0000  
Ending Coordinates, North: 5071.8346 East: 4894.7441  
Error, N: 71.83 E: -105.26 Total: 127.43 Brg: S 55°41'15"E  
Distance Traversed: 1308.19 Closure: 10

A full report including acreage may be viewed by pressing the F2 key to view the CAD Text Window. You may also view/print the display file.

*Chapter 4. CGSurvey Module* 860
Visual Map Check

This routine allows you to graphically pick the Call Text (Bearings and Distance) from a drawing and perform a Map Check Closure.

Prompts

First you will be asked: Pick Point of Beginning: You can enter the beginning point number, or graphically pick the point on the screen.

Next: Pick Bearing Text for Leg 1 (ask Reverse is ON) [Off/Done]<Done>: Graphically pick the text with the Bearing. If "ask Reverse" is turned ON, you will be allowed to reverse the direction of the bearing after it is selected:

Next: Pick Distance Text for Leg 1: Graphically pick the text with the distance. You will see:
If you select YES, you will go to the next leg. If you select NO: you will be asked to pick the Bearing and distance for Leg 1 again.

After selecting all the Calls: press ENTER for DONE. You will have the option:

If you select YES, the information: you selected will be placed in a Map Check File. You will be asked to select the CGM file.

Next: Enter the starting and ending coordinates for the traverse.

The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:
CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NOT OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRTE will overwrite all points without asking, DO NOT OVERWRITE: will only write NEW points to the coordinate file.

Below is a sample Report:
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 9586.74896 East: 9586.74832
Error, N: -413.25104 E: -413.25168 Total: 584.42568 Brg: N 45°00'00"E
Distance Traversed: 1492.10700 Closure: 3

Adjusted by Least Squares
Bearing Distance Northing Easting Elevation Point ID
10000.00000 10000.00000 900.00000 1
S 58°19'27"W 146.64772 9922.99352 9875.19793 2
N 05°19'46"W 299.65818 10221.35627 9847.36450 3
N 73°17'06"W 156.24457 10266.29428 9697.72179 4
S 04°35'43"E 226.90862 10040.11507 9715.90113 5
S 64°19'20"E 371.14929 9879.29253 10050.39763 900.00000 1

Sq. Feet: 814183.13568 Acres: 18.69107

Pulldown menu Location: CGTrav
Keyboard Command: VM, cg_visual_mapcheck
Prerequisite: Call Text must be displayed to select

Create StarNet File
This option converts a raw data file to the Star*Net (.DAT) format. The raw data file will be preprocessed. During conversion, multiple distances and angles will be averaged and compared to the maximum ranges set in the Traverse Options dialog box. To use this option properly, you must know how Star*Net works. You should be familiar with all Star*Net codes and commands.
NOTE: This manual is not a substitute for the Star*Net manual.

Below is a sample raw data file that contains three different traverse types. This raw data file can be reduced using CG-SURVEY or written to a Star*Net file for reduction with Star*Net, both without any editing.

<table>
<thead>
<tr>
<th>Station</th>
<th>Easting</th>
<th>Northing</th>
<th>Zone</th>
<th>Datum</th>
<th>1st Leg</th>
<th>2nd Leg</th>
<th>3rd Leg</th>
<th>4th Leg</th>
<th>5th Leg</th>
<th>6th Leg</th>
<th>7th Leg</th>
</tr>
</thead>
<tbody>
<tr>
<td>C 11000</td>
<td>1000</td>
<td>923.56</td>
<td></td>
<td></td>
<td>5.00</td>
<td>109.19170</td>
<td>292.310</td>
<td>88.35000</td>
<td>2</td>
<td>H&amp;T</td>
<td></td>
</tr>
<tr>
<td>C 21205.25</td>
<td>1208.13</td>
<td>931</td>
<td></td>
<td></td>
<td>5.00</td>
<td>289.19300</td>
<td>292.310</td>
<td>271.25100</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C 51127.73</td>
<td>739.05</td>
<td>930</td>
<td></td>
<td></td>
<td>5.00</td>
<td>180.00200</td>
<td>290.540</td>
<td>271.25100</td>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>L.T. begin main loop traverse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 5.32</td>
<td>5.00</td>
<td>0.00000</td>
<td>290.540</td>
<td>88.35000</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 5.20</td>
<td>5.00</td>
<td>0.00000</td>
<td>292.310</td>
<td>91.31300</td>
<td>6</td>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>98.03580</td>
<td>324.280</td>
<td>88.31320</td>
<td>3</td>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>190.32100</td>
<td>52.390</td>
<td>90.32550</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>10.32120</td>
<td>52.390</td>
<td>269.27080</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>180.00100</td>
<td>292.310</td>
<td>268.28320</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 4.98</td>
<td>5.00</td>
<td>0.00000</td>
<td>324.280</td>
<td>91.10000</td>
<td>4</td>
<td>IPF</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>124.03560</td>
<td>275.840</td>
<td>92.22400</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>304.03400</td>
<td>275.840</td>
<td>267.37100</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.00</td>
<td>179.59500</td>
<td>324.280</td>
<td>268.50200</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OT begin open traverse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 5.03</td>
<td>5.00</td>
<td>0.00000</td>
<td>135.260</td>
<td>95.23150</td>
<td>20</td>
<td>Nail</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20 5.12</td>
<td>5.00</td>
<td>185.23560</td>
<td>116.450</td>
<td>85.23150</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chapter 4. CGSurvey Module
The coordinate formats (C code) are the same for Star*Net and CG-SURVEY; no translation is necessary.

If a comment line in the raw data file uses a valid Star*Net code or command, it will be used in its original form (as with coordinates); not as a comment. These codes are #, C, A, D, V, B, M, TB, T, TE, SS (followed by a space) and all dot commands. (example: .CURVE, .SCALE, etc...)

Multiplication factors are converted to the .Scale command. The original multiplication factor set in the Global Options dialog box will be placed at the beginning of the Star*Net file. Other multiplication factors will be placed as they occur in the raw data file.

NOTE: You cannot use a multiplication factor for meter/feet conversion in a 3-D traverse in Star*Net 3.2.

Reference bearings/azimuths are converted to the B format.

All traverse points are converted to the M format and side shots to the SS format. Only points used once (as a foresight point) will be considered a side shot. If a point is located from more than one instrument setup, or is used as an instrument point or backsight point, the point will be converted to a M format.

The LT, ET, OT, FT and CT codes are converted to comments. Point codes are combined with descriptions.
If Elevations are on, the Star*Net file must be adjusted as a 3-D traverse. The following could occur:

If you input slope distances and vertical angles, all distances will first be reduced to their horizontal/vertical components. Multiple distances will be averaged and then a slope distance and vertical angle will be recomputed from the averaged horizontal/vertical components. This is done so Star*Net can compute corrections for curvature and refraction and vertical divergence (can only be done if vertical angles are used in a 3-D traverse.) A ".Delta Off" command will be placed in the Star*Net file.

If Curvature and Refraction is on in the Options/Global Options dialog box, a Curve command will be placed in the Star*Net file.

If you input horizontal and vertical distances, a ".Delta On" command will be placed in the Star*Net file. No corrections for curvature and refraction or vertical divergence will be possible.

If Elevations are off in the Options/Global Options dialog box, the Star*Net file must be reduced as a 2-D traverse. The following will occur:

If you input slope distances and vertical angles, all distances will be reduced to their horizontal/vertical components and the vertical components will be thrown away. Multiple distances will be averaged.

No corrections for curvature and refraction or vertical divergence are allowed in a 2-D traverse with Star*Net version 3.2 or earlier.

Pulldown Menu Location: CGTrav
Keyboard Command: STN, CG_REDUCE_STARNET
Prerequisite: Open CG Raw file *.CGR

CGCogo

General Information

The Command Line:
Throughout CGSurvey the user will be prompted at the command line for input. Typically the command line is at
the bottom of the CAD graphic screen, although the command line can be placed above the graphics screen. To enter a command at the command line use the keyboard, and press the <Enter> key when finished. The F2 hot key can be used at any time to access a full text window that displays user input and history. As point numbers are typed in, or selected on the screen using the mouse, the point number entered is displayed at the command line. When the next point ID is requested the previous point ID is used as the starting point for the command.

For example, when inversing from 5 to 7. First you type 5 at the command line and press <Enter>.

Command:
[Point group/Reset/sNap on] (last point = <none>): 5
[Clockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5):

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.
To clear the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inverse**

This command allows you to determine the bearing and distance between the endpoints of a line or a curve by entering the points that define the line or curve.

After choosing the Inverse menu item you are asked to "Enter point sequence". A point sequence is a series of points that define the points being used to calculate the inverse. You may enter one point ID at a time to inverse from point to point. You may enter the two points separated by a dash (5-7), etc.

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): 5
[Clockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5): 7

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.
To "Reset" the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inversing Around Curves Clockwise**

To inverse around a clockwise curve (one curving to the right), enter the PC point ID then enter "L" or "+" to indicate a clockwise curve. Next enter the point ID of the radius point of the clockwise curve and follow with the PT point ID.

For Example:

First enter the PC of the curve. In this example type or pick point ID 2201
Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): 2201
Now type L or "+" and <Enter> for a clockwise curve
Enter point sequence
[Clockwise curve/Ccw curve/Point group/Reset] (last point = 2201): L
Next type or pick the radius point ID 2200
Enter radius point for curve [Reset/sNap on]: 2200
You may also use the mouse to pick a C&G Arc. In this case, the arc's radius point will be used
Next type or pick the PT point ID 2202
Inversing Around Curves Counter Clockwise
To inverse around a curve in a counter-clockwise direction (curving to the left) simply type W or "-" and <Enter> then proceed as with a clockwise curve.

Inversing between a series of points in the coordinate file
By entering 2 point numbers separated by a "+" you can inverse through successive point IDs in the order they are found in the coordinate file (either numeric or alphabetic order). For example, if you enter 3+6, inverses will be calculated and displayed from point 3 to 4, 4 to 5 and 5 to 6. You can use the <F2> key to view the information printed at the command line or you can view the print file (CGFile > Print/View Print File).

Inversing using Point Groups:
You can use a Point Group to inverse between a series of points specified by the point group. To specify a point group type a P or '*' and <Enter> at the command line. This will display a dialog box showing the Point Groups currently in the default directory.

Prompts

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): Enter or pick the first point on a line or the PC of a curve. Type "P" and Enter to use a point group to specify the inversing sequence. Type "R" and Enter to Reset the last point. Type "N" and Enter to turn on CAD snaps (these are turned off when the command starts).
[ccW curve/Point group/Reset/sNap on] (last point = 5): Enter or pick the next point ID to inverse to or type "L" and Enter or "W" and Enter to specify the radius point of a curve.

if you are entering a curve:
Enter radius point for curve [Reset/turn Snap on]: Enter or pick the radius point for the curve.
Enter point of tangency (PT) for curve [Reset/turn Snap on]: Enter or pick the PT point for the curve.

Pull down Menu Location: CG-Survey > Cogo
Keyboard Command: cg_inverse
Prerequisite: coordinate file

Intersects
This feature allows you to calculate intersections based on one of the following methods:

Bearing-bearing
The bearing-bearing intersect is calculated based on a line passing through a point on a given bearing intersecting another line passing through a second point on another specified bearing.

Bearing-distance
This is based on a line passing through a point at a given bearing intersecting a circle at a given distance (radius) from a second point. This intersection by result in 2 points of intersection.

Distance-distance
This is based on intersecting a circle at a given distance (radius) from a point with another circle at another given distance (radius) from a second point. This may also result in 2 points of intersection.
**Perpendicular**
This is based on calculating the perpendicular distance from a given point to a line that passes through another point at a specified bearing.

**Tangent**
This is based on calculating the tangent points of a line drawn from a given point to a circle having a specified radius and radius point.

**Command line input**
After selecting the Intersects option on the CGCogo pull down menu and the Use Intersects Dialog menu item is not checked you will see the following prompt.

Intersection method: Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on
[BB/BD/DD/Perp/Tangent/turn-Offsets-on]:

**Bearing-Bearing Intersections:**

Type "bb", then press <Enter>
At the Enter first Point: prompt type in or pick the point using the mouse
As an illustration, using the example shown in the figure: type or pick point 2203.
At the Enter first bearing: prompt there are 3 options available:
Type the bearing directly using the special C&G notation qddmmss (quadrant, degrees, minutes and econds)
105.2316 (N 05° 23' 16''E)

Enter the two known C&G points that define the bearing either by typing the two points in with a dash between them or picking the two points one at a time using the mouse.
Or select a C&G line. When you select a line the bearing is computed by inversing between the two points that created the line. The bearing quadrant is based on traversing from the end point of the line farthest from the location where the line was picked to the end point of the line nearest to the point picked.
Enter second point: for the example type or pick point 2204
Enter second bearing: use any of the methods outlined for entering first bearing.
The intersection will then be calculated, the intersection point saved to the coordinate file and the results displayed
at the command line.

When saving the intersection point, depending on your settings on the Global Settings tab of the C&G Options dialog, you may be asked to either enter or change the point ID, elevation, point code and description.

At each of the STORING POINT prompts there is an option to change settings [Settings]. Pressing S will
bring up the Global Options tab of the C&G Options dialog box, allowing you to change settings prior to saving the
point. (see the CGTools Chapter for a description of the CGOptions dialog box)

**Bearing-Distance Intersection**

Type bd to calculate the intersection of a circle with a line. Generally, the data is entered in the same fashion as for
a bearing-bearing intersection.
Once the data is entered each of the two solutions will be displayed one at a time.
You will be asked if the solution shown is the correct solution.

Is this the correct solution [Yes/No/ESC]:

If the solution is the correct one press Y for <Yes>. If it is not the correct solution press N for <No> and
the second solution will be displayed. If neither solution is correct press <Esc> to cancel and return to the previous
prompt.

**Distance-Distance Intersection**
Type dd to calculate the intersection of two circles: with the distances being the radii of the circles.
You will be prompted to enter the first radius point and distance (radius).
You will then be asked to enter the second radius point and distance (radius).
As with the bearing-distance intersection, the two possible solutions will be displayed and you will be asked to choose the correct one (see dialog below).

If you click the No button the other possible solution will be displayed. If you click the Yes button the intersection point will be stored. If you click Cancel the point will not be stored.

The routine will continue with additional DD Intersections prompts until you escape [ESC] the routine.
The process will be repeated until the user presses <Esc> twice to end the command.

Perpendicular Intersection
Press P and <Enter> to calculate the point where the perpendicular constructed from a given point to a line intersects the line.
At the Enter first Point <>: prompt, type or pick a point on the line (in the example illustrated in the figure, type or pick point 2514)
At the Enter bearing: <>: prompt, type the bearing of the line or type or pick the two points defining the bearing (in the example, 2514-2513)
You will then be asked if you want to Store Perp. Int. Pt. (Yes/No):
Choose whether to store the calculated point or simply view the data (you may not want to save the resulting intersection point).
Enter second point <>: Type the point ID, or use the mouse to pick the point from which the perpendicular to line is to be constructed (in the example, 2488).
The STORE POINT prompt will indicate the point being stored (in the example it will be 2489). Press <ESC> to cancel point storage.
To exit the Instrsects feature, the user must press <Esc> twice or the routine will repeat.

**Tangent Intersection**
Type T and <Enter> to calculate the points at which a line from a given point becomes tangent to a circle. You must choose a radius point for the circle, the radius of the circle, and the external point from which the tangent will start.

At the Enter radius point for circle: prompt, type or pick the center or radius point of the circle (in the example, 2490)
At the Enter radius of circle: prompt, type the radius or type or pick two points that define the radius distance (in this example, 2490-2492, or 69.92’)
At the Second point: prompt, type or pick the point through which the tangent lines must pass (in the example, 2491)

As in some of the other intersection types, you must select the desired solution from the two possible solutions using the dialog shown for the distance-distance intersect. If you click the Yes button, the intersection point will then be saved to the coordinate file and the results displayed at the command line.

To end the command, press <Esc> twice or the routine will repeat

**Turn-Offsets-on:**
Type O and <Enter> to turn the use of offsets on or off.
An example of an offset intersection would be the easement lines for a sewer line. This routine can calculate the offset intersection say for a 7.5' left offset and a 10' right offset, as shown.
For example:
Enter first offset distance < >: -7.50
Enter Second offset distance < >: 10.00
The offset distances are positive if right of the line, as seen looking down the line in the direction of the defined bearing, negative if left of the line.

Intersects dialog
If the Use Intersects Dialog menu item is checked you will see the following dialog:

```
To use the Intersects dialog just set the Intersect Type drop down list to specify the type of intersect you wish to do. Next click on the item you wish to specify. You may type in the information or you can move the cursor over the drawing area and you will be prompted for the information required for the edit box you were last in. To enter the next item, click on that edit box and type the information or, as before, move the cursor over the drawing and you will be prompted for the necessary information for the last edit box you were in. Continue to do this until all information has been entered then click the Compute button to compute the intersection. The results will be printed
```
on the CAD command line and to the print file. If the Store Intersect Point check box is checked the intersection point will be stored in the coordinate file. You may specify offsets by checking the Specify Offsets checkbox and entering or picking the offset distance(s). Click the Reset button to remove all entered data from the dialog.

You may perform any other commands while the Intersects dialog is displayed - the data entered in the dialog will remain for use at any time.

Prompts

Not using Intersects Dialog:
Intersection method: Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on
[BB/BD/DD/Perp/Tangent/turn-Offsets-on]: Type the 1 or 2 capitalized letters to specify the type of intersect to calculate or to turn offsets on.
point prompts
Enter point: Type a point ID or pick a point symbol on the screen.
Enter first point: Type a point ID or pick a point symbol on the screen.
Enter second point: Type a point ID or pick a point symbol on the screen.
Enter radius point for circle: Type a point ID or pick a point symbol on the screen.
Enter point on tangent line: Type a point ID or pick a point symbol on the screen.
bearing prompts:
Enter bearing <100.0000>: Type or pick the bearing.
Enter first bearing <100.0000>: Type or pick the bearing.
Enter second bearing <100.0000>: Type or pick the bearing.
distance prompts:
Enter distance <0.000000>: Type or pick the distance.
Enter 1st distance <0.000000>: Type or pick the distance.
Enter radius of circle <0.000000>: Type or pick the distance.
perpendicular intersect prompt:
Store perpendicular intersect point [Yes/No] <N>: Type "Y" or "N" and Enter.
Stopping to allow viewing of intersect point (red X) <Enter to continue> This prompt is displayed if you answered "N" to the previous prompt. Just press Enter to continue.
Intersects dialog: Type or pick the data into the appropriate edit boxes then click the Compute button to view the results and save the intersection point to the coordinate file.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_intersects
Prerequisite: coordinate file

Station Offset

In order to use the station offset functions, you must create a Point Group (formerly called a batch point file or point file) defining a centerline alignment. The Coordinate Management > Point Groups > Create section describes how you can create a Point Group.
To illustrate the use of point groups in the various station offset features, the following point group file will be used:

7.25+ (Slope in, 1st vert. Curve)
1.75- (Slope out, 1st vert. curve & slope in, 2nd vert. Curve)
200+ (Vertical Curve Length curve 1)
/123.50 (PVI Elevation curve 1)
*1300 (PVI Station curve 1)
2.00- (Slope out of curve 2)
*1750 (PVI Station curve 2)
300* (Curve Length curve 2)
1000 (Subgroup name - also default beginning station)
2001 (Point ID at Sta. 10+00)
2002 (Point ID at PC of Curve)
-2003 (Radius point ID, '-' indicates counter clockwise)
2004 (Point ID at PT of curve)
2005 (Point ID at PC of curve)
+2006 (Radius point ID , '+' indicates clockwise curve)
2007 (Point ID of PT of curve)
2008 (Point ID of PC of curve)
+2009 (Radius point ID, ' +' indicates a clockwise curve)
2010 (Point ID of PT of curve - last entry in subgroup and in file)

NOTE: Information shown in parenthesis are comments used here for explanation and do not appear in the point group file itself.

Alignment used for examples

---

**Coords From Station Offset**

This feature allows you to calculate and store a coordinate point for any given station and offset along an alignment defined by a point group. Use the Select a C&G Point Group File dialog to open a point group file.
Enter Starting Station [Done] <0.0000> You can Press <Enter> to use the default station shown, or you can enter a new starting station. If you enter a "+" followed by a value, ex. "+50", all stations on a 50 foot interval will be calculated automatically.

Enter Offset <0.00000>: Enter the offset distance from the alignment.
The point ID, station, offset, northing, easting, elevation and description will be printed at the command line and written to the print file.

You may repeat the process until you have calculated all the desired stations or press D then <Enter> to exit the command.

Note: If Elevations are set to "Calculate" and Elevation is on, (See General tab of the C&G Options dialog) then you will be asked to "Enter constant elevation change for offset points". The constant elevation change will be added to or subtracted from the calculated elevation of each newly created point on the alignment. If there is vertical curve information contained in the point group, this information will be used to calculate the initial elevation of each point. If there is no vertical curve information, the elevation of each new point will be calculated by interpolation between the elevations of the points contained in the point group.

Prompts

Enter Starting Station [Done] <0.0000>: You can Press <Enter> to use the default station shown, or you can enter a new starting station.

Enter station [Interval] <0.000000>: Enter a station expressed as a decimal number. Type "I" and Enter to specify an interval or, alternatively, you can precede the station number with a "+". This will cause stations to be automatically calculated based on the value you specify.

If you choose Interval in the previous prompt:

Enter interval: Enter the desired interval for automatic generation of stations.

Enter offset (+ = right, - = left) <0.000000>: Enter the offset distance from the alignment.

Pulldown Menu Location: CG-Survey > Cogo > Station Offset

Keyboard Command: cg_crds_from_staoff
**Prerequisite:** coordinate file, point group file defining the alignment

---

### Create Point Group From Station Offset

This feature allows you create a point group by locating all the points along a predefined alignment at a given offset. It then sorts the points by station and saves the points to a new Point Group.

Select Create Point Group from Station-Offset from the menu.

Use the Select a C&G Point Group File: to open the point group file specifying the points in the alignment.

At the Calculate new points on the control line [Yes/No] <Y> prompt,

If you answer no to this prompt, the points chosen by you in the previous step will be saved in station order to the new point group file.

If you answer yes to the prompt, a new point will be created exactly on the offset line for each point found in the coordinate file that lies within the given range. The elevation of the new point will be set to the elevation of the nearby existing point and the new point IDs will be written to the new point group file instead of the existing point IDs.

Repeat the above steps to specify another offset.

Press D for <Done> to exit.

---

### Prompts

**At the Enter Offset <0.00000>:** Type an offset if desired or just press enter for no offset. Offsets to the left should be preceded by a ",".

**At the Enter Maximum Range <0.0000>:** Specify the tolerance for points not exactly on the alignment.

**Choose initial points for base selection set from coord file. (Enter when done)**

**Calculate new points on the control line [Yes/No] <Y>:** Type "Y" and Enter or just Enter to create new points on the alignment for those points found to be near the alignment and place these new point IDs in the point group being created. Type "N" and Enter to place the existing points in the point group being created.

---

**Pulldown Menu Location:** CG-Survey > Cogo > Station Offset

**Keyboard Command:** cg_bpf_from_sta

**Prerequisite:** coordinate file, point group containing the points in the alignment

---

### Display Centerline Stations

This feature allows you to view a list of the centerline stations for a given point group.

In the file dialog select the point group file that defines the alignment.

At the Enter Starting Station [Done] <1000>: prompt you will notice that the subgroup name is used to determine the starting station default value. To use the default value, press <Enter>. You may also enter a new starting station for the first point in the point group. For example, 24+34.12 is entered as 2434.12.

The centerline station information will be listed on the command line and written to the print file.
The Enter Starting Station (Done) <0.00000>: prompt will again be displayed at the command line, at this point you can either enter another point group, or type in another starting elevation. When done entering data, type D and <Enter> for to end the command.

NOTE: The first line of the Point Group must be the beginning station of the alignment. In any routine that computes or requires stationing information the station numbers must be relative to the stationing in the Point Group file.

Prompts

At the Enter Starting Station [Done] <1000>: Enter the starting station for the alignment as a decimal number.

Pulldown Menu Location: CG-Survey > Cogo > Station Offset
Keyboard Command: cg_display_cl_stalsta
Prerequisite: coordinate file, point group file defining an alignment

Station Offset From Coords

This feature allows you to calculate the station and offset of selected points in the current coordinate file, based on the alignment as defined by the Point Group.

Select Station Offset from Coords from the menu.
You will first be asked to open the point group file that defines the alignment.
At the Enter Starting Station [Done] <0.00000>: prompt, enter the station of the first point in the point group. For example, if the first station is 24+34.12, enter it as 2434.12. (As an example using the point group listed in the previous section, the starting station must be greater than 1000, the starting station in the point group, and less than 2016.05, the station of the last point in the point group. If not, no information will be displayed.)
Enter Maximum Range <0.00000>: The range identifies how far to look left and right of the alignment for points in the current coordinate file.
Next, you will be asked to select the points to be considered in computing the station offsets

Add points from coordinate file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limit/Radius/Select]:
At the prompt type A and <Enter> for all the points in the current coordinate file or use the other options to choose a subset of the points. As indicated by the prompt, press <Enter> by itself to end point selection.
The station and offset information will be printed in order by station.
The Enter Start Station [Done] <0.0000>: prompt will appear again, you may enter the next starting station or type D and <Enter> to end the command.

Prompts

Enter Starting Station [Done] <0.00000>: Enter the starting station as a decimal number.
Enter Maximum Range <0.00000>: The range defines the distance tolerance left and right of the alignment for points selected from the current coordinate file.
Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use the various methods to select points from the coordinate file to be searched for proximity to the alignment.

Pulldown Menu Location: CG-Survey > Cogo > Station Offset
Keyboard Command: cg_staoff_from_crds
Prerequisite: coordinate file, an existing point group file defining the alignment
Points on Line

This feature allows you to calculate and store points along a line at specified distances.
After choosing Points on Line from the menu and, if needed, opening a coordinate file, you will see following prompt:

Pts on line - specify No. of pts & dist., divide line, or place pts at interval [Number and dist/Divide/Interval]:

Choose one of the following:
Number and dist: Type N and <Enter> to specify a number of points at a given interval from the start point on a line.
Divide: Type D and <Enter> to select a line and indicate how many points you wish to create. The program then creates the specified number of points equally spaced along the length of the line.
Interval: Type I and <Enter> to create points at the specified interval along a line defined by 2 points.

Number and dist
This option allows you to calculate a given number of points at a fixed distance along a line. For example, you can set the corners for 3 lots at 150' intervals.
At the Enter start point: prompt, enter a point on the desired line by typing a point ID or picking a point with the mouse.
At the Enter bearing: prompt, use any one of the methods available to enter the bearing of the line on which you wish the points to fall.

At the Enter distance: prompt, use any of the available methods to enter the distance between the points along the line.
Enter number of points: Enter the number of points you want created. At the STORING POINT: prompt data required will vary depending on your current settings. You can enter a point number and its elevation, description, and code. This prompt will appear for each of the points created along the line.
The Enter start point: prompt will repeat until you press <Esc>.
Pressing <Esc> again will allow you to create points on a line using one of the other methods.
Pressing <Esc> a third time to end command.

Divide
Choosing this method allows you to create points by dividing a line between two points into a specified number of divisions.
Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.
Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.
Enter number of segments: Enter the number of points you want to create. As the points are saved respond to the STORING POINT: prompt as required.
The Enter start point: will repeat unless you press <Esc>.
After pressing <Esc> once you may choose another method of creating points on a line or press <Esc> once more to end command.

Interval
This option allows you to create as many points as possible at a specified interval on a line between two points.
Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.
Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.
Enter Distance: Enter the desired distance between the points created along the line. Points will be created along the line at the given distance. As many points as will fit between the end points at the given spacing will be created.
No matter which method is used to create points, the Saving Point dialog (see below) will appear for each of the points created.

Click OK to save the point in the coordinate file.

Repeat from the Enter start point: prompt or press <Esc> to use another method to create points along a line. Press <Esc> once more to end the command.

**Prompts**

Specify: Number of points and distance, divide line or points at an interval

(Number_and_dist/Divide/Interval): Type "N" and Enter to create a specified number of points along a line a specified distance apart. Type "D" and Enter to create a specified number of points between 2 points. Type "I" and Enter to create a point a specified distance from the starting point of a line specified by 2 points.

**Enter start point:** Enter the point ID or pick the point symbol for the starting point of the line.

for Number and Dist:
- **Enter bearing <100.0000>:** Enter the bearing of the line along which the points are to be created.
- **Enter distance <0.000000>:** Enter the distance between the points.
- **Enter number of points:** Enter the number of points to be created.

for Divide:
- **Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.
- **Enter number of segments:** Specify the number of points to be created on the line between its end points.

for Interval:
- **Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.
- **Enter distance <0.000000>:** Enter or pick the distance along the line for creating the new point.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** cg_pol
Prerequisite: coordinate file

Curves

There are several possible curve calculations available on the Curves submenu. The available options will be described in the following sections.

Calculate Horizontal

This feature allows you to calculate the components of a horizontal curve but does not save any points to the coordinate file.

In the dialog enter any two curve components then press OK to calculate the other components.
To use the mouse to pick the two known components press the Pick button and pick the PC, PT and radius points or a C&G or non-C&G arc.
The description field is merely used to identify the curve in the printout.
The Reset button clears all fields.
When done, press the Cancel button to close the dialog.

Prompts

Horizontal Curve Calculation dialog: Enter any two curve components then press OK to calculate the other components.

Pull-down Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_horz_calc
Prerequisite: None
This feature allows you to calculate the curve components for a curve between two tangent lines given either the radius, the length of the tangent line or a point through which the arc passes.

At the Enter first point [Done]: prompt, enter or pick a point on one of the tangent lines. The point ID of the point selected will be displayed on the command line.

Enter first Bearing <100.000000>: use any of the available methods to enter the bearing from the point you just selected going toward to the point of intersection (P.I.) of the curve. The bearing entered will be displayed on the command line.

Enter second point: type or pick a point on the other tangent line.

Enter second bearing <100.000000>: enter the bearing of the other tangent.

Offset out <0.000000>: This is an optional entry. It allows you to calculate a point outside the curve (for example, on the right-of-way). Press <Enter> to use the default value or enter another offset. The offset used will be displayed on the command line.

Offset in <0.000000>: 50 This is optional entry allows you to calculate a point inside the curve.

Enter point on arc [Radius mode/Tangent-Distance mode]:

At this prompt there are three options as to how to specify the location of the desired curve:

At this prompt you can type or pick a point on the arc,

Or you can type R and <Enter> to get the prompt:

Specify radius of curve [Tangent-mode/Point-on-arc-mode]:

At this prompt specify the radius of the curve.

Or you can type T and <Enter> to get the prompt:

Specify tangent distance [Radius-mode/Point-on-arc-mode:

At this prompt enter the distance from the PC or PT to the PI.

The locations of the PC, PI, PT, and radius point are calculated and the Saving Point dialog (see below) will appear once for each.

Depending on the Global Options settings, the calculated points may be drawn. If Auto Line Plot is on, the arc will be drawn as well. The coordinates of points that were created and the curve information will be displayed at the command line.
Prompts

**Specify an existing point on the first tangent line [Done]:** Enter or pick a point on one of the tangent lines.
**Specify the bearing of the first tangent line <100.0000>:** Enter the bearing or pick 2 points or a line to define the bearing.

**Specify an existing point on the second tangent line:** Enter or pick a point on the second tangent line.
**Specify the bearing of the second tangent line <100.0000>:** Enter or pick the bearing of the second tangent.

**Offset out <0.000000>:** This is an optional entry. It allows you to calculate a point outside the curve
**Offset in <0.000000>:** This is an optional entry allows you to calculate a point inside the curve.

**Specify an existing point on the arc [Radius_mode/Tangent_distance_mode]:** Enter or pick a point on the arc or change how you define the arc by entering "R" and Enter for the Radius method or 'T' for the Tangent-distance method

**Specify radius of curve [Tangent_distance_mode/Point_on_arc_mode]:** Enter the radius or change the mode.
**Specify tangent distance [Radius_mode/Point-on-arc-mode]:** Enter the tangent distance or change the mode.

**Middle Ordinate Solution**

Allows you to calculate the other curve elements when you can locate the chord and determine the middle ordinate distance in the field.

**Prompts**

**Save coordinates [Yes/No] <Y>:** press Enter or type "Y" and Enter if you want the calculated radius point to be stored in the coordinate file. If not type "N" and Enter. Press Esc key to end the command.
**Enter P.C. point:** specify the PC point by typing a point ID or picking a point on the screen.
**Enter PT point:** specify the PT point by typing a point ID or picking a point on the screen.
**Middle ordinate:** Type in the middle ordinate distance or pick it on the screen.

**Points on Arc**

This feature allows you to create points along an arc. The first point is set at a distance measured along the arc starting at the PC.

Enter PC point or pick a C&G Curve: enter or pick the PC point or pick a C&G curve.
If you picked a C&G Curve, the PC, Radius point, Pt point and arc length will be displayed at the command line.
After picking a C&G Curve, skip the next 2 steps.
Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: For a clockwise curve either type L or '+', and <Enter> then pick or type a point ID or type a point ID preceded by a '+'. For a counter clockwise curve either type a W or a '-', and <Enter> then pick or type a point ID or type a point ID preceded by a '-'.

Enter arc length [Occupy/Multiple points] <0.000000>:

Occupy option
In occupy mode the points are located along the arc with the arc length being measured from the previous point. Thus the occupied point moves ahead to the last computed point as calculations proceed. When you type O and <Enter> the prompt becomes:

Enter arc length [do not Occupy/Multiple points] <0.000000>:

Specify the arc length at the prompt.
A point will be created and you will be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.

Multiple points option
This option allows you to compute multiple points along the arc at a given distance. The specified distance is used to set as many points along the arc as will fit between the PC and the PT. When you type M and <Enter> the prompt becomes:

Enter arc length [do not Occupy/Single point] <0.000000>:

Specify the arc length at the prompt.
A as many points as can be fit between the PC and the PT will be created. You will then be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.

At the Enter PC point or pick a C&G Curve: prompt you can continue specifying curves or you can press <Esc> to end the command.

Prompts

Enter PC point or pick a C&G Curve: Enter a point ID or pick a point symbol or a C&G Arc on the screen. Press Esc to end the command.

Enter PT point: Enter or pick the PT point.

Enter radius point [cLockwise/ccW]: For a clockwise curve either type "L" (or a plus sign (+)) and <Enter> then pick or type a point ID or type a point ID preceded by a '+'. For a counter clockwise curve either type a "W" (or a minus sign (-)) and <Enter> then pick or type a point ID or type a point ID preceded by a '-'.

Enter arc length [Occupy/Multiple points] <0.000000>: Enter an arc length to create a single point on the arc. Enter "O" and Enter to "occupy" the calculated point so the next arc length is calculated from that point instead of the PC. Enter "M" and Enter to calculate multiple points along the arc at a specified distance.

Enter arc length [do not Occupy/Single point] <0.000000>: For multiple points enter the desired arc length or change input mode.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_poa
Prerequisite: coordinate file

Spiral Curve Design
This feature allows you to design a spiral curve. You will be prompted using standard spiral curve component nomenclature.

Follow the prompts described in the Prompts section below and the following Spiral curve data is calculated and displayed at the command line and written to the print file.
Point of Intersection of the spiral (PI for spiral)
Tangent point of the spiral (TS for spiral)
Point where spiral meets simple curve (SC for spiral)
Radius point of the simple curve
Point where simple curve meets outgoing spiral (CS for spiral)
Point where spiral meets tangent on outgoing side (TS for spiral)
For each of the points calculated the prompt
The Saving Point dialog (see below) will appear and allow you to specify the point ID.

Click OK to cause the point to be stored in the coordinate file.

At the Curve Description <enter if done>: prompt you can either enter the description for another curve or press <Enter> to end the command.

**Prompts**

**Curve description <enter if none>:** This description is optional but is used to identify the information in the results. Press Enter to end the command.

**Enter the first point:** Enter or pick a point on the tangent going into the spiral.

**Enter first bearing <100.0000>:** Enter or pick the bearing from first point to the P.I of the spiral.

**Enter second point:** Enter or pick a point on the tangent going out of the spiral.

**Enter second bearing <100.0000>:** Enter the bearing from second point to the P.I.

**Enter Radius [Degree_of_curve] <0.000000>:** Enter or pick the radius or type "D" and Enter to change to degree of curve prompt.

or

**Enter Degree of Curve [Radius]:** Enter or pick the degree of curve or type "R" and Enter to change to radius prompt.

**Enter spiral length in <0.00000>:** Enter or pick the length of the spiral coming from the first tangent into the simple curve. Enter a zero for no spiral in.

**Enter spiral length out <0.00000>:** Enter the length of the spiral from the simple curve out to the second tangent. Enter a zero for no spiral out.
Spiral Curve Stakeout

This feature allows you to calculate points along a spiral at a given interval and offset for use in staking out the curve in the field.

**Curve Description <enter if done>:** This text description is only used to identify the spiral curve data printed at the command line and written to the print file.

**Enter the first point:** Enter or pick a point on the tangent line going into the spiral.

**Enter first bearing <100.00000>:** Enter the bearing going toward the P.I. of the spiral from the first point.

**Enter second point:** Enter or pick a point on the tangent line going out of the spiral.

**Enter second bearing <100.0000>:** Enter or pick the bearing from the second tangent point just defined to the P.I. for the spiral.

**Enter Radius [Degree of Curve] <0.0000>:**
- **Radius option:** Entering the radius is the default option as indicated by the wording of the prompt.
- **Degree of Curve option:** To change to entering the degree of curve type D and <Enter>.

Once you have chosen the type of data you wish to specify, type or pick the radius of the simple curve between the two tangents or the degree of curve.

**Enter spiral length in <0.00000>:** Enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.

**Enter spiral length out <0.00000>:** Enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.

**Enter P.I. station <0.0000>:** Enter the station of the PI. For example: station 460+28.52 is entered as 46028.52

**Enter station interval <0.0000>:** Specify the interval at which you wish to stake the spiral. For example, enter 50 to stake every 50 units.

**Enter offset from centerline <0.0000>:** This can be a positive or negative number depending on whether you want to set points inside or outside the spiral. If you want to place points on the centerline, simply press <Enter> to use the 0.00 default value.

**Odd stations to be staked (6+34.22 as 634.22):** You can stake as many odd station locations as needed. When done press <Enter> without entering a station value.

The points will be calculated and stored in the coordinate file. The station and offset will be placed in the description field.

The results will be printed at the command line and in the print file.

**Prompts**

**Curve Description <enter if done>:** This text description is optional and is used to identify the spiral curve in the output.

**Enter the first point:** Enter or pick a point on the tangent line going into the spiral.

**Enter first bearing <100.000000>:** Enter the bearing going toward the P.I. of the spiral from the first point.

**Enter the second point:** Enter or pick a point on the tangent line going out of the spiral.

**Enter second bearing <100.0000>:** Enter or pick the bearing from the second tangent point to the P.I. for the spiral.

**Enter Radius [Degree of Curve] <0.0000>:** Enter or pick the radius. or, to change to entering the degree of curve, type "D" and Enter.
Enter spiral length in <0.000000>: enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.

Enter spiral length out <0.000000>: enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.

Enter P.I. station <0.0000>: Enter the station of the PI. For example: station 460+28.52 is entered as 46028.52

Odd stations to be staked (6+34.22 as 634.22): Enter as many odd stations as needed. When done press Enter.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_sc
Prerequisite: coordinate file

**Stakeout Horizontal**

This feature allows you to create points for field staking a horizontal curve.

After choosing the Horizontal Stakeout menu item, and opening a coordinate file you will be asked if you want to Save coordinates [Yes/No] <Y>.

If you respond Yes (or press enter), a new point will be saved to the coordinate file for each point to be staked along the curve. No matter how you answer this question, stakeout information will be generated and displayed.

Enter curve description: Enter a description that will allow you to identify the curve in the output.

P.C. station <0.000000>: Enter the station for the P.C. of the curve.

Station interval <0.000000>: Enter an interval for staking the points along the curve.

Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter the station of any odd location along the curve to be staked. For example, you may wish to stake the point on the curve at which a pipe crosses or the point where the extension of a property line intersects the curve. You may enter as many odd stations as required. When done, press <Enter> at the prompt without entering a new odd station or press D and <Enter>.

Offset from C/L <0.000000>: enter a non-zero value here if you must stake points offset from the main alignment - for example: along a curb line, a barrier wall or along a property line.

If the distance is entered as a positive number, the distance will be added to the radius or staked outside the curve. If the number entered is negative, it will be subtracted from the radius or staked inside the curve. To stake the centerline, enter zero.

At the Enter PC point or pick a curve: prompt you can type a point ID for the P.C. or use the mouse to pick a point or a C&G curve on the screen.

If you picked a C&G curve in the previous step, you need not enter the PT point or the radius point so skip the next 2 steps.

Enter PT point: type the point ID for the P.T. or click the point on the screen.

Enter radius point [cLockwise/ccW]: Use any of the available methods of specifying a radius point.

Type the radius point: If the curve is in a clockwise direction from the P.C. to the P.T., enter the point number preceded by a plus sign, e.g. +18. If the curve is in a counterclockwise direction from the P.C. to the P.T., the point ID preceded by a minus sign, e.g. -18.

Pick the radius point with the mouse: If the curve is in a clockwise direction from the P.C. to the P.T., type an L or a '+' and <Enter>, then use the mouse to pick the point on the screen. If the curve is in a counterclockwise direction from the P.C. to the P.T., type either a W or a '-' and <Enter>, then pick the point on the screen.

The report will be printed at the command line and written to the print file.

The command will repeat until you press <Esc> at the Save coordinates [Yes/No] <Y>: prompt to end command.

**Prompts**

Save coordinates [Yes/No] <Y>: Type "Y" and Enter or just Enter if you wish to save resulting points to coordinate file. Type "N" and Enter if not. Press Esc to end command.

Enter curve description: Enter a description that will allow you to identify the curve in the output.

P.C. station <0.000000>: Enter the station for the P.C. of the curve.
Station interval <0.000000>: Enter an interval for staking the points along the curve.
Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter as many "odd" stations to be staked. Type Enter or "Done" and Enter when all odd stations have been entered.
Offset from C/L <0.000000>: If you wish to stake stations not on the centerline, enter the offset and press Enter or just press Enter to accept the default offset. Positive offset is outside the radius and negative is inside.
Enter PC point or pick a curve: Enter a point ID, pick a point symbol or pick a C&G arc.
if you did not pick a C&G arc:
Enter PT point: Enter or pick the PT point.
Enter radius point [clockwise/ccW]: Enter "L" or "W" to choose the type of curve then Enter or pick the radius point. You may also enter "+" and Enter then enter or pick a point for the radius point of a clockwise curve or Enter a "-" and enter or pick a point for the radius point of a counter clockwise curve.

Tangent Between Curves
This feature allows you to calculate the end points of a tangent line joining two curves. This may be used, for example, to layout roads which do not have curve/tangent information.

Follow the prompts noted below and, if a solution is possible, the endpoints of the tangent between the two curves will be calculated. Point IDs will be assigned and coordinates stored for the points of tangency. Repeat or enter "D" when done.

NOTE: There are 4 tangent solutions for this problem. The solutions sets differ according to the sign preceding the radius or degree of curve.
Enter first radius point [Done]: Enter or pick the center point for one of the curves. Press Enter or type "D" and Enter when done.
Enter first radius <0.00000>: Enter the radius of the first curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.
Enter second radius point: Enter or pick the center point for the second curve.
Enter second radius <0.00000>: Enter the radius for the second curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.

Vertical Curve Design
This feature prints a list of station and elevation information for stations along one or more vertical curves.

Use the Odd stations to be staked (6+34.22 as 634.22): prompt to enter any stations along the curve for which you wish elevation information. This permits you to calculate elevations over culverts or at other important locations.
The calculated station and elevation information . The station, tangent elevation, tangent offset and grade elevation will be printed at the command line and in the print file. The high or low point will be marked with an asterisk.
Repeat the process to design another vertical curve or press <Esc> at the Enter curve description: prompt to end
Prompts

Enter curve description: Description is used to identify the curve in the output.
Enter slope in <0.00000>: The slope is entered as a percent. For example: enter -1.5 for a 1.5% downhill slope.
Enter slope out <0.00000>: Enter the slope as a percent.
Enter length of vertical curve <0.00000>: Enter the length of the vertical curve.
Enter PVI Station <0.000000>: Enter the PVI station. For example: Enter 1250.00 for station 12+50.00
Enter PVI Elevation <0.000000>: Enter the PVI elevation.
Enter station interval <0.000000>: Enter the station interval.
Odd stations to be staked (6+34.22 as 634.22): Enter any stations along the curve for which you wish elevation information.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_vcd
Prerequisite: coordinate file

Area Summary

The Area Summary feature allows you to get information on the area and perimeter of one or more parcels and the tract that contains the parcels.

After choosing the Area Summary menu item and, if required, opening a coordinate file, you are asked to specify the type of Area Summary you want:

Type of Area Summary [Complete/Area only/Mapcheck] <C>:

Complete Area Summary

Complete summary allows you to get complete information on the area and perimeter of parcels and the tract that contains the parcels

Source of points defining area [Point group/Manual entry] <P>
If you have a Point Group, enter <P>. Enter <M> if you prefer to manually enter the points.

Once the overall area and parcels have been defined either by using a point group or manually entering the information, the Complete Area Summary is displayed at the command line.
The points used in defining the area are listed first. If there are any arcs involved in the area computation, all of the elements of the curve will be displayed as well. After listing the points defining the area, the area and perimeter summary are reported.

Area Only

The data input is the same as for the Complete Area Summary but the report produced contains only the area of each parcel and the accumulated area for the entire tract

Mapcheck Area

The data input is the same as for the Complete Area Summary as is the resulting report except that it also includes closure information. The closure information includes the correct ending coordinates; the actual ending coordinates; the northings, eastings, and bearing and distance of the error; the total distance traversed and the overall closure.

Prompts

Open Coordinate File dialog: If a coordinate file is not open, you will be asked to open one.
Type of Area Summary [Complete/Area only/Mapcheck] <C>: Press "C" and Enter or just Enter for Complete,
"A" for Area only, or "M" for Mapcheck.

**Source of points defining area [Point group/Manual entry] <P>:** Type "P" and Enter or just Enter to use a point group to specify the points defining the tract. Type "M" and Enter to specify the points defining the tract by typing in point numbers or picking from the screen.

**Pulldown Menu Location:** CG-Survey > Cogo > Area

**Keyboard Command:** cg_assm

**Prerequisite:** coordinate file

---

**Roadways**

The roadways submenu contains 2 features: Right-of-Way/Easements and Intersections/Cul-de-Sacs and the Intersections/Cul-de-Sacs has a submenu containing several features for each type of intersection or cul-de-sac.

---

**Right-of-Way Easements**

The Right-of-Way/Easements feature allows you to compute offsets left and/or right of an alignment. After the alignment points have been entered, offset points will be created to the left and right of each point you specified in the alignment. If Auto Point Numbering is on, the calculated points will be stored in the coordinate file. Depending on your settings for Auto Line Plot and Auto Point Plot in the Graphic tab of the C&G Options dialog, the new points and lines may also be drawn. If Auto Point Numbering is off, you will see the Saving Point dialog and can accept or change the default point number and other information associated with the point.

**Prompts**

**Enter offset right <0.000000>:** Enter the offset to the right of the alignment.
**Enter offset left <0.000000>:** Enter the offset to the left of the alignment.

**Method for specifying center line points [Point group/Manual entry] <P>:** To use a point group type "P" and Enter or just Enter and select the point group from a file dialog box. Type "M" and Enter to specify the alignment interactively.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways

**Keyboard Command:** cg_rw

**Prerequisite:** coordinate file containing points defining the alignment

---

**Intersections/Cul-de-sacs**

**T Intersections**

This feature allows you to calculate the right-of-way intersection points and/or the fillet points and fillet radius points (if fillets are used) at T type intersections. One or both of the roads may have arc centerlines. The points defining the fillet points will be calculated and stored in the coordinate file. Repeat as needed or press <Esc> or <Enter> at the Enter C/L intersection point (Enter when done): prompt to end the command.

**Prompts**

**Enter C/L intersection point (Enter when done):** enter or pick the centerline intersection point.
**Enter through road C/L bearing [Arc] <0.000000>:** If the through road is a straight road, enter or pick the bearing for the road. Otherwise type A and <Enter> to switch to Arc mode and enter the radius point of the through road.
**Enter through road width <0.000000>:** Enter the width of the through road.
**Enter 2nd road C/L bearing away from intersection [Arc] <0.000>:** enter the 2nd bearing or press <A> for
Arc and enter the radius point. The bearing is away from the intersection.

**Enter 2nd road width <0.000>:** Enter the 2nd road width.

**Enter fillet radius <0.000>:** If you do not want to have fillets, press <Enter> to use the 0.00 default value. Otherwise, enter the fillet radius.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs  
**Keyboard Command:** cg_tint  
**Prerequisite:** coordinate file

---

### X Intersections

The radius, PC and PT points for each fillet will be calculated and stored. If Auto Line Plot is on, the fillet arcs will be drawn. Repeat as needed then press Enter or Esc to end the command.

**Prompts**

**Enter C/L intersection point (Enter when done):** enter or pick the intersection point of the two road centerlines.  
**Enter 1st road C/L bearing [Arc]:** If first road is straight, enter the 1st bearing. If it is an Arc, enter the 1st radius point.  
**Enter 1st road width:** Enter 2nd road C/L bearing (Arc): If the intersection point for the first road centerline is on a straight segment, enter the bearing of the centerline. If it is on an arc, type A and <Enter> then enter the first road centerline's radius point.  
**Enter 2nd road width:** Enter the second road width.  
**Enter 2nd road C/L bearing [Arc]:** Enter the second road centerline bearing or type A and <Enter> and specify the centerline radius point for the second road.  
**Enter fillet radius:** Enter the fillet radius or zero, if there are no fillets.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs  
**Keyboard Command:** cg_xint  
**Prerequisite:** coordinate file

---

### Y Intersections

The radius, PC and PT points for each fillet will be calculated and stored and if Auto Line Plot is on, the fillet arcs will be drawn. Repeat as necessary then press <Esc> or <Enter> to end command.

**Prompts**

**Enter C/L intersection point (Enter when done):** Enter or pick the intersection point for the three road centerlines.  
**Enter 1st road C/L bearing away from intersection point:** Enter one of the road centerline bearings (going away from the intersection point).  
**Enter 1st road width:** enter the first road width.  
**Enter 2nd road C/L bearing away from intersection point:** Enter another of the road centerline bearings (going away from the intersection.)  
**Enter 2nd road width:** Enter the width of the second road.  
**Enter 3rd road C/L bearing away from intersection point:** Enter last of the road centerline bearings (going away from the intersection.)  
**Enter 3rd road width:** Enter width of third road.  
**Enter fillet radius:** Enter radius of fillets or zero for none.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs
**Bubble Cul-de-Sac**
This type of cul-de-sac is also called a fish-eye cul-de-sac. It is commonly used at sharp turns in roads in subdivisions.

Follow the prompts described below. When done the fillet points and radius points will be stored in the coordinate file. These points will be plotted and the fillet arcs will be drawn if the C&G settings call for it. You may repeat the process as necessary or press <Esc> to end command:

**Prompts**

- **Enter cul-de-sac radius point (Enter when done):** type or pick the radius point.
- **Enter cul-de-sac radius <0.000>:** Enter the radius of the cul-de-sac.
- **Enter 1st C/L bearing away from radius point <0.000>:** Enter the bearing along the first roadway centerline away from the cul-de-sac radius point.
- **Enter 2nd C/L bearing away from radius point <0.000>:** Enter the bearing along the second roadway centerline away from the cul-de-sac radius point.
- **Enter road width <0.000>:** Enter the roadway width.
- **Enter fillet radius <0.000>:** Enter the fillet radius or zero for no fillets.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs

**Keyboard Command:** cg_bcul

**Prerequisite:** coordinate file

---

**Standard Cul-de-Sac**

The standard cul-de-sac is a common feature of most subdivisions.

Enter cul-de-sac radius point (ENTER when done): type or pick the cul-de-sac radius point (in this example, point 2301).

- **Enter cul-de-sac radius <0.000000>:** Enter or pick the radius of the cul-de-sac (60 units in the example).
- **Enter C/L bearing away from radius point [Arc]:** In computing a straight cul-de-sac you must enter the bearing of the road centerline going away from the radius point. For the example the bearing is from point 2301 to point 2302.
- **Enter point on C/L (NOT radius point):** This must be a C&G point on the centerline but cannot be the same as the cul-de-sac radius point. In this case we can use point 2302.
- **Enter road width <0.000000>:** enter the total width of the road right-of-way.
- **Enter fillet radius <0.000000>:** Enter the fillet radius. Remember, you do not have to have a fillet radius, you may enter zero here.

The points needed to define the cul-de-sac and the fillets are calculated and stored in the coordinate file.

If Auto Line Plot is on the lines for the cul-de-sac and the fillets will be drawn automatically.

You may repeat the process as many times as necessary.

When done, press <Enter> at the

Enter cul-de-sac radius point (ENTER when done):
Standard Cul-de-Sac on ARC

The procedure for a cul-de-sac on arc is the same as it is for a straight cul-de-sac, except at the
Enter C/L bearing away from radius point [Arc] : prompt, choose A for Arc, then enter the C/L radius point for the
roadway, in this case point 2313.

Offset cul-de-sac:

The procedure for offset cul-de-sac is the same as a straight cul-de-sac except the radius point is the offset point. In
the sketch, the point 2324 is the radius point. The bearing is from 2324 toward 2326 and the point on the C/L would
be point 2325.

Prompts

**Enter cul-de-sac radius point (ENTER when done):** type or pick the cul-de-sac radius point. Press Enter when
done.

**Enter cul-de-sac radius <0.000000>:** Enter or pick the radius of the cul-de-sac.

**Enter C/L bearing away from radius point [Arc] :** Enter or pick a point. For a straight cul-de-sac roadway, this
must be a point on the centerline but cannot be the same as the cul-de-sac radius point. Type "A" and Enter to
specify information for a cul-de-sac on a curved roadway.

if you chose a curved roadway:

**Enter C/L radius point [Line]:** Type a point ID or pick a point symbol or type "L" and Enter to switch back to a
straight roadway.

**Enter point on C/L (NOT radius point):** Type a point ID or pick a point symbol.

**Enter road width <0.000000>:**

**Enter fillet radius <0.000000>:** Enter the fillet radius. You may enter 0.0 for no fillets.

Stake-Out

The Stakeout feature allows you to calculate the required information for either a radial stakeout or staking out using
angles right.

**Angles Right**

This feature is similar to the Radial Stakeout feature except it allows you select the foresight points one at a time.

If a coordinate file is not open, a file dialog will appear, allowing you to open an existing coordinate file.

After following the prompts outlined below, the angle from the backsight point, the distance, the frontsight point
ID, the azimuth and the description are printed at the command line and written to the print file.

You may press <F2> to view the complete listing of angles and distances.

Repeat the prompt sequence as many times as are required.

Press <Enter> or type D and <Enter> when done.

Prompts
Enter the instrument point. [Done]: Type or pick the instrument point.
Enter backsight point. [Done]: Type or pick the backsight point.
Enter foresight point. [Done]: Type or pick the foresight point.

Pulldown Menu Location: CG-Survey > Cogo > Stake-Out
Keyboard Command: cg_ar
Prerequisite: coordinate file

Radial Stake Out
This feature allows you to obtain the angles required to stakeout several foresight points from a single instrument point.

If a coordinate file is not open, a file dialog box will appear, allowing you to open an existing coordinate file.
After following the prompts outlined below, the angles right from the backsight point, the distances, the foresight point IDs, the azimuths and the descriptions for all the selected points will be printed at the command line and written to the print file.
You may press <F2> to view the complete listing of angles and distances.
Repeat as necessary for as many setups as are required.
When done, press <Enter> to end the command.

Prompts

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use one of several methods to specify the points in the coordinate file to be staked out.
Enter the Instrument point [Done]: Type or pick the instrument point.
Enter backsight point [Done]: Type or pick the backsight point.

Pulldown Menu Location: CG-Survey > Cogo > Stake-Out
Keyboard Command: cg_rso
Prerequisite: coordinate file

Best Fit
The best fit feature uses a least squares algorithm to compute the best fit line or circle for the points selected. The user can assign a weight to each point that is between 1 and 15, a point with a weight of 15 acts as if there are 15 of the points at the same location and thus skews the fit closer to that point. This is done to skew the result in favor of certain points. A weight of 0 means do not adjust this point or give it "infinite" weight.

When you choose Best Fit from the CGCogo menu you will see the following prompt:
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:
Best Fit Line:
Press <Enter> for Line to calculate the best fit line through a series of points. In the example in the figure below, 2075 is an Iron Pin Found that we do not want adjusted, so the weight will be set to 0.

Enter a point ID or pick a point symbol on the line: for the example, type or pick 2075
Enter weight for point 2075 <1>: for the example type 0 (zero) and <Enter>
Enter a point ID or pick a point symbol on the line: for the example, type or pick 2076
Enter weight for point 2076 <1>: for the example, type 8 and <Enter>
Continue entering point ID - weight pairs until done then press <Enter> when asked for the next point ID.
The point locations and weights will be used to compute the best fit line.
The results, a list of the point IDs entered and their offsets from the best fit line and the bearing of the line, is printed
at the command line and written to the print file.
Printed output for the line example
Pt.: 2075 Wt.: 0 Offset: 0.000 RT
Pt.: 2076 Wt.: 8 Offset: 5.360 LT
Pt.: 2077 Wt.: 3 Offset: 3.411 RT
Pt.: 2078 Wt.: 6 Offset: 1.915 RT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2080 Wt.: 4 Offset: 1.093 RT
Pt.: 2081 Wt.: 4 Offset: 0.986 RT
N: 6354.64727 E: 8112.07615 Dir: N 88°30'32''E
N: 6366.14982 E: 8553.96369 Dir: S 88°30'32''W

At the [Edit/Ok/Quit] <0> prompt:
If you are satisfied with the results, press <Enter> for Ok and the endpoint coordinates will be computed and saved.
For each point saved, the Saving Point dialog (see below) will be shown.

Clicking OK will cause the point to be saved to the coordinate file.

If, on the other hand, you wish to edit the input data, type E and <Enter>. You see the following prompt:
[Add/Change/Delete/eXit]:
Add - add another point to the calculation
Change - change the weight of one of the points
Delete - remove one of the points from the calculation
eXit - when done editing.
If you wish to cancel the command without calculating the line type Q and <Enter>.

Best Fit ARC:
This option allows you to calculate the best fit arc through a series of points. As with the Line option, each point can be weighted from 0 (no adjustment) to 15.

At the Enter the type of best fit problem prompt, type A and <Enter> to choose the Arc option.

Enter the point ID - weight pairs as in the Line option.

When all the point ID - weight pairs have been entered press <Enter> at the Enter or Pick a C&G point on the line prompt.

A table of the results similar to that for the Line option will be displayed at the command line.

Output for the example in shown in the figure

Pt.: 2083 Offset: 2.862 OUT
Pt.: 2084 Offset: 3.699 IN
Pt.: 2085 Offset: 3.608 OUT
Pt.: 2086 Offset: 6.280 IN
Pt.: 2087 Offset: 5.584 OUT
Pt.: 2088 Offset: 1.393 IN
N: 6369.30690 E: 8269.70677 RAD: 237.282

The [Edit/Ok/Quit] <O>: prompt and its options for editing the input data are explained in the section on the Line option.

If you are satisfied with the results, press <Enter> for Ok and the PC, PT and radius point of the best fit arc will be saved to the coordinate file using the Saving Point dialog.

Tan-arc-tan:
This option allows you to calculate a combination of the best fit tangent line going into a curve, the best fit arc for the curve itself and the best fit tangent line out of the curve through a series of points defining two tangent lines and an arc.

The two tangent lines are calculated using a least squares solution and then the best fit arc is calculated. The method used to find the best fit arc is to calculate a radius and radius point for each point on the arc using a function that calculates a curve between tangents through a known point. Each radius and radius point is weighted based on the central angles between the PC, point-on-arc and PT points. The larger the central angles, the higher the resulting weight will be. All the calculated radii and radius points are then averaged. It is not necessary that you locate the actual PC or PT points in the field.

At the prompt
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>: 

First you must enter the points on the 1st tangent line. At the series of prompts to:
Enter a point ID or pick a point symbol on 1st tangent:
and
Enter weight for point XXXXX <1>:
enter the point ID - weight pairs for the tangent going into the curve.
When done entering the tangent line points, press <Enter> when asked for the next point.
Next at the series of prompts:
Enter a point ID or pick a point symbol on the arc:
Enter the points for the arc. Weights for these points are calculated by the program.
In the example shown in the figure, there are 2 points defining the first tangent, 3 points defining the arc and 2 points defining the tangent out.
Output for example shown in figure

Pt.: 2210 Wt.: 0 Offset: 0.000
Pt.: 2211 Wt.: 5 Offset: 0.000

N: 6512.07291 E: 8572.91824 Dir: N 45°00'00''E
N: 6567.12692 E: 8627.97226 Dir: S 45°00'00''W

Pt.: 2212 Wt.: 5 Offset: 0.000 LT
Pt.: 2213 Wt.: 1 Offset: 0.000 LT

N: 6585.04757 E: 8796.89599 Dir: S 45°00'49''E
N: 6505.88861 E: 8876.09255 Dir: N 45°00'49''W

Pt.: 2214 Offset: 1.736 OUT
Pt.: 2215 Offset: 3.232 IN
Pt.: 2216 Offset: 2.324 OUT

N: 6492.00101 E: 8721.39653 RAD: 119.183

The [Edit/Ok/Quit] <O>: prompt following the output is explained in the Line option.
If you are satisfied with the results press <Enter> for Ok.
The coordinates for the endpoints of the tangents and PC, PT and radius point of the curve are computed and saved to the coordinate file using the Saving Point dialog.

Prompts

Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>: Type "L" and Enter or just Enter for a best fit line, "A" and Enter for a best fit arc or "T" and Enter for the best fit of a curve with two straight tangents in and out.

For a best fit line or arc:
**Enter or Pick a C&G point on the line (or Arc):** Type a point ID or pick a point symbol on the screen. Repeats until all points are entered and the user presses Enter at this prompt.
**Enter weight for point <####> <1>:** Enter a number between 0 and 15 (0 = infinite weight).

For best fit tan-arc-tan:
**Enter a point ID or pick a point symbol on 1st tangent:** Enter or pick as many points and weights as desired for the first tangent line.
**Enter a point ID or pick a point symbol on the arc:** Enter of pick as many points as desired for the arc (weights are determined by the program).
**Enter a point ID or pick a point symbol on 2nd tangent:** Enter or pick as many points and weights as desired for the second tangent line.

[Edit/Ok/Quit] <O>: Type "E" and Enter if you wish to change the weight of a point or add or delete points. Type "O" and Enter or just Enter to calculate the best fit line, arc or line-arc-line and store its defining points in the coordinate file. Type "Q" and Enter to quit without calculating the best fit points.
[Add/Change/Delete/eXit]: if you choose Edit then this prompt allows you to Add a point, Change a weight, or Delete a point. When done editing press "X" and Enter to return to the Edit/Ok/Quit prompt.
Triangulation

This feature allows you to calculate the location of an unknown point given the angles at the 3 vertices of the triangle formed by the 2 known points and the unknown point. Enter the point ID of the first known point then the point ID of the 2nd known point (the backsight) and the measured horizontal angle to the unknown point. Do the same for the 2nd known point backsighting the 1st known point. Next, if available, enter the angle between the 2 known points with the instrument at the unknown point. The standard deviation and other information for the calculation will be printed at the command line and written to the print file. The calculated point will be saved to the coordinate file using the Saving Point dialog (Shown Below).

Prompts

Enter first instrument point: Enter a point ID or pick a point symbol on the screen.
Enter first backsight point: Enter a point ID or pick a point symbol on the screen.
Enter first horizontal angle to unknown point: Enter an angle.
Enter second instrument point: Enter a point ID or pick a point symbol on the screen.
Enter second backsight point: Enter a point ID or pick a point symbol on the screen.
Enter second horizontal angle to unknown point: Enter an angle.
Enter horizontal angle at unknown point or <skip> <0.000000>: Enter an angle if available or press Enter to skip.
NAD83

This feature allows you to convert longitude and latitude to and from NAD83 state plane coordinate systems.

**NOTE:** Do not use this function for any other coordinate system, i.e. NAD 1927. Make sure the correct state is selected on the General tab of the C&G Options dialog box.

After choosing the NAD83 menu item from the CGCogo menu you will be prompted for the necessary data.

At the Enter zone prompt enter the letter for the appropriate zone for the area where the survey was performed. The zones allowed may vary by state.

[Coords to longitude-latitude/Longitude-latitude to coordinates] \(<C>:\)

**Coords to longitude-latitude**

Pressed \(<\text{Enter}>\) (or type \(C\) and \(<\text{Enter}>\))
you will be asked to select the points.

After selecting points a table of longitude-latitude and related data for the points will be printed at the command line

**Longitude-latitude to coordinates**

Type \(L\) and \(<\text{Enter}>\),

You will be asked to enter the longitude and latitude of the points you wish to calculate.

When you have entered the final longitude-latitude pair press \(<\text{Enter}>\) when asked for the next latitude.

The computed points will be stored in the coordinate file using the Saving Point dialog shown below.

![Saving Point dialog](image)

Click OK to save the point to the coordinate file.

Repeat until done or press \(<\text{Enter}>\) to end the command.

**Prompts**
Enter zone (E, W): enter the letter for the appropriate zone for the area where the survey was performed. The letters allowed will vary depending on the state. 

[Coords_to_longitude Latitude/Longitude Latitude_to coords] <C>: Type "C" and Enter or just Enter to calculate coordinates given longitude and latitude. Type "L" and Enter to do the reverse.

if you chose Coords to longitude-latitude:
Choose initial points for base selection set from coord file. (Enter when done)

[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use the various selection methods to choose the points for which you wish to calculate longitude and latitude

if you chose Longitude-latitude to Coords:

Enter latitude [<Enter> when done]: Enter the latitude angle for a longitude - latitude pair.
Enter longitude: Enter the longitude angle for a longitude - latitude pair.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_nad83
Prerequisite: coordinate file

**CGDraw**

**Drawing Settings**

See CG Options... menu item in the Tools menu.

Pulldown Menu Location: CG-Survey > CGDraw>Drawing Settings
Keyboard Command: DSU, CG_DRAW_SETUP
Prerequisite: None

**Set Line Type**

To use a line type it must be loaded and it must be the current line type. The current line type will be used for any lines or polylines drawn. The Set Line Type feature allows you to load line types from any line type file (*.lin) and to specify the currently active line type. It gives you easy access to the most commonly use line type files while allowing you to access any line type file available to you.
Prompts

Clicking the Set Line Type menu item brings up the Line Types dialog: By default the dialog displays the acad.lin line type file contents (CgSu.lin in the standalone version of CGSurvey).

By clicking the AutoCAD/IntelliCAD ISO button: you can view the acadiso.lin file line types (CgSu-iso.lin in the standalone version of CGSurvey).

By clicking the C&G button: you can view the custom line types created for CGSurvey (in CgLinedefs.lin). You may also use the Browse... button to view and load line types from other line type files.

To load a line type: pick the file the line type is in, highlight the desired line type, then click the Load button. Notice that the status column now indicates that the line type is "Loaded".

To make the highlighted line type current: click the Set Current button. The status column now reads "Loaded (C)", indicating that the line type is loaded and it is the currently active line type.

You can load a line type and make it current: by double-clicking it. If it is already loaded, double-clicking will make it current.

Cancel button: returns the current line type to what it was before the command was run.

Click the Done button: to close the dialog.

Pulldown Menu Location: CG-Survey > CGDraw > Set Line Type
Keyboard Command: SLT, CG_SET_LINE_TYPE
Prerequisite: None
Global Edit allows you to make several changes to one or more entities, in one operation.

**Prompts**

After selecting Global Edit from the CGDraw menu you will be asked to specify the method of entity selection at the command line:

- **Screen**: This option allows you to use any of the standard mouse based CAD selection methods.
- **Points**: Allows you to select C&G points using the standard C&G selection methods. Checking a given check box activates that section of the dialog box and allows you to make the desired changes.
- **Done**: When finished selecting the entities enter "D" for done this will bring up the Dialog box.

**There are five basic sections in this dialog.**

- **All**: checking this checkbox is just a fast way of checking all the checkboxes and thus allows you to edit all of the properties of the selected entities.
- **CAD properties**
  - **Layer**: change the layer of the items selected
  - **Color**: Change the color of the items selected
  - **Font/Style**: Change the font style to a another existing font style.
  - **Text Size**: Change the current Text size (this setting is in inches)

- **Lines**
**Linetype:** set the linetype for the lines selected. Pressing the down arrow will bring up a list of all of the available linetypes.

**Line Scale:** This allows you to set the length of the pattern.

**Line Stop:** This allows you to set the line stop. This item will only be activated if a C&G line was chosen.

---

**Without Linestop**

---**With Linestop**

Line stop is a C&G parameter that allows you to stop the line short of the point symbol plotted at the point location thus the line can be made to not go through the symbol. For example, if you were plotting 0.10 diameter circles for property corners, you could set the line stop to .10. This would cause a C&G line drawn to the property corner to end .05 plotted units short of the actual corner and thus not cross the property corner point symbol.

**Calls**

**Distance precision:** From the pull down select the number of decimal places to be displayed.

**Angle precision:** From the pull down simple select the angle precision you need.

**Points**

This portion of the Global Edit dialog allows you to change various aspects of point symbols:

- **Symbol:** from the pull down select the new symbol to use.
- **Symbol Size:** set the symbol size (in inches or cm)
- **Point Label Size:** Set the point label size (in inches or cm)
- **Point Label Position:** Displays the point label configuration dialog box, set the options as needed.
- **Elevation Places Displayed:** set the number of places to be displayed.

**Pulldown Menu Location:** CG-Survey > CGDraw>Global Edit

**Keyboard Command:** GE, CG,GLOBAL_EDIT

**Prerequisite:** Coordinate file

**Border**

This option allows you to place a border Polyline on your drawing with sheet sizes.
Prompts

Sheet Setup

Sheet Size: The letters A, B, C, etc. refer to ANSI sheet size standards. You also have the option of creating and naming custom sizes.

Rotate 90 Degrees: when checked will rotate the border 90 degrees.

Border Inset: specifies the inset distance for the border. Keep in mind this inset distance is measured from the edge of the plotable area of your plotter. Check the plotter manual for plotter specifications.

Layer: The layer the border will be drawn on.

Line Width: The thickness of the border line in inches (cm).

Press OK button when done and the border polyline will be drawn at the mouse cursor. You can move it to the correct location and left click to place it there.

Pulldown Menu Location: CG-Survey > CGDraw > Border

Keyboard Command: DB, CG_DRAW_BORDER

Prerequisite: None

Coordinate Grid

Choosing the Coordinate Grid item in the CGDraw menu brings up the Grid Configuration dialog. The various areas of the dialog are described below:

Map Grid: is used to provide a visual reference grid to show northings and eastings on a map. A Map Grid can be labeled along its border to show the coordinate values of the grid lines. The Map Grid is oriented North-South East-West whereas a Layout Grid can be oriented at any specified bearing.

Layout Grid: is meant to be used to create points on a regular grid for laying out building columns, a topo grid, etc. A Layout Grid does not allow for a border nor for coordinate labels along the border.
Grid Layer: specify the layer the grid is to be created on. The layer does not need to exist prior to running this command.

Lines: If selected grid lines will be drawn for the full height and width of the grid dimensions.
Crosses: Only crosses will be drawn at the grid intersections for the full height and width of the grid dimensions.
Cross Height (drawing units): this defines the size of the crosses in drawing units. If your drawing scale is 40 feet and you wish to have crosses that are 0.25 inches when plotted, you must specify cross height as 10 feet.
Draw Border: If checked, a border will be drawn around the perimeter of the defined grid. You can choose a different layer for the border if you wish. This will allow you to set the color, line thickness and/or line type for the border (this option is not available for Layout Grid).
Draw Labels: Label the grid lines or crosses around the perimeter at the same interval as the Baseline and Perpendicular intervals (this option is not available for Layout Grid). If checked you must specify:
Label Interval: This number must be some even multiple of both the baseline and perpendicular intervals. The Label Interval CAN NOT be less than the base or perpendicular interval settings.
Label Decimal Places: Specify the number of decimal places used for the label text.
Label Layer: Specify the layer the labels are to be drawn on.

Grid Dimensions: Baseline Extent: This is the total width of the grid, East to West (or parallel to the baseline bearing in the case of a Layout Grid).
Perpendicular Extent: This is the total height of the grid perpendicular to the baseline.
Baseline Interval: This is the distance between the grid lines (or X's) drawn perpendicular to the baseline
Perpendicular Interval: This is the distance between the grid lines (or X's) drawn parallel to the baseline.

Grid Baseline:

Use Point ID for Baseline Origin: checking this box allows you to use an existing C&G coordinate for the Grid Origin. This is typically used for a Layout Grid.
Enter the point ID, or select the point from the screen.
Origin Northing/Origin Easting: manually enter the Northing and Easting value for the grid origin or pick it on the screen using the Pick Origin button.
Baseline Bearing: This is only used when you are drawing a Layout Grid. This is the bearing of the baseline. Use the standard C&G bearing input format qdd.mmss (e.g. 125.3527 for N25°35’27”E or 325.5405 for S25E54°04’W)
Pick Origin button: This option allows you to pick the origin graphically on the screen. You do not have to pick a C&G point.

Create Points at Grid Intersections:
Checking this box will cause the default C&G point to be plotted at each grid point or grid line intersection and a corresponding point to be stored in the currently open coordinate file. This is especially useful when creating a Layout Grid.
Point Description: enter a point description for the points saved to the coordinate file.
Exclude Area: This button allows you to graphically specify a horizontal window within which no grid is to be drawn. This can be used to guarantee that a title block, legend or other area is not obscured by the grid or its labels.
Preview: This button allows you to preview the grid as specified. Pressing <Enter> will return you to the Grid Configuration dialog allowing you to make changes if necessary.
Cancel : This button exits the command without drawing the grid.
OK: This button causes the grid to be drawn.

Pulldown Menu Location: CG-Survey > CGDraw>Coordinate Grid
Keyboard Command: GRD, CG_DRAW_GRID
Prerequisite: Coordinate file
**Text on Arc**

**Create**

Text on arc allows you to create text that follows an arc specified by you. Each word in the text is a separate block and can be moved later as needed.

**Prompts**

You will be prompted to Enter Text to place on arc:

![Image of text entry screen]

Type the desired text then press <Enter>:

**Enter center point for arc:** using the mouse, select the center point of the arc the text is to follow, this can be a C&G point, or any point in the drawing. You need not actually have an arc drawn.

**Enter Midpoint of text:** select the midpoint of the text, this can be a C&G point, or any point in the drawing.

**Move to desired location:** The text will be drawn at the cursor. Move the cursor to the desired location and left click to place the text.

**Pulldown Menu Location:** CG-Survey > CGDraw> Text on Arc > Create  
**Keyboard Command:** TOA, CG_TOA  
**Prerequisite:** Coordinate file

**Move**

Allows you to move all the text associated with the selected text-on-arc entity.

**Prompts**

**Select entities:** select text  
**Entities in set:** 1 item is found and selected  
**Select entities:** press <Enter> to accept entry  
**Move Text to desired location:** move text  
**Select entities:** repeating the selection set  
**Press <ESC> or <Enter>:** to end command

**Pulldown Menu Location:** CG-Survey > CGDraw> Text on Arc > Move  
**Keyboard Command:** MTA, CG_MOVE_TOA  
**Prerequisite:** Coordinate file

**Edit**

Allows you to edit the text associated with a text-on-arc entity.
Text: Arc=107.6709, R=75.7740 (Edit Text)

Text Attributes

Layer: 0 (current)
Text Size: 0.100 inches (Default)
Text color: Bylayer
Set Color Button: select a new color
Text style: Standard text style

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <ESC> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw > Text on Arc > Edit
Keyboard Command: ETA, CG_EDIT_TOA
Prerequisite: Coordinate file

Delete

Allows you to delete all the text associated with a text-on-arc entity.

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <Esc> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw > Text on Arc > Delete
Keyboard Command: DTA, CG_DELETE_TOA
Draw Mapcheck

This routine will draw a mapcheck file. The settings allow you to plot points, draw lines, and place calls all at the same time.

If a mapcheck file is NOT currently open when you open the map check file routine a dialog box will prompt you to open a mapcheck file. Once a mapcheck file is open the following dialog box will open.

If the mapcheck file displayed at the top of the dialog box is not the file you want to draw you can use the browse button to search for another file.

You also have the option to edit the file which will take you to the mapcheck editor (CGEditor).

Reduce File: If this item is checked there will be a closure report written to the print file and the command line.

Starting/Ending Points: You have the option of entering an existing point number or manually entering the northing and easting. If you enter an existing point number the northing and easting values will be read from the coordinate file and placed in the appropriate edit boxes (see below).

If the starting and ending point are the same point, you need only enter the starting point values.

Clicking the Select Point button will cause the Draw Mapcheck dialog to be hidden thus allowing you to pick the starting and ending points from the screen or use the command prompt:
Select starting point for mapcheck:
or
Select ending point for mapcheck:

rather than manually entering the point number or coordinate values in the edit boxes.

**Lines:** This portion of the dialog allows you to turn on or off the draw line command as well as select the linetype and layer where the line will be drawn.

![Lines Dialog](image)

**Calls:** This section of the dialog allows you to turn on or off the draw calls command as well as edit the call setup options.

![Calls Dialog](image)

**Point Symbols:** This area of the dialog allows you to turn on or off the draw point symbols command as well as having a button that will take you to the drawing settings dialog. At the drawing settings dialog you can change the symbol, symbol size, label options and more.

![Point Symbols Dialog](image)

**OK:** Selecting ok will cause the mapcheck file to be drawn, based on the current settings as described above.

**Prompts**

Select starting point for mapcheck: Select a point symbol or type a point number for the starting point.
or
Select ending point for mapcheck: Select a point symbol or type a point number for the ending point.

Pulldown Menu Location: CG-Survey > CGDraw > Draw Mapcheck
Keyboard Command: DMP, CG_DRAW_MAPCHECK
Prerequisite: Open Mapcheck file *.cgm

Multi-Draw
This feature allows you to complete several drawing operations at the same time. For example, in one operation you can plot points and generate a coordinate table for the points at the same time. Or you can draw lines by points and place calls on the resulting lines at the same time.

Prompts
When you choose Multi-Draw from the CGDraw menu, the Multi-Draw dialog box is displayed.

Specify Points

Use the radio buttons to indicate how you want to specify the points that will be used for the drawing operations. You can Choose Points Interactively using the standard C&G point sequence command line interface or you can Use Point Group.
NOTE: If you Choose Points Interactively, you will not have the option of plotting points or creating a coordinate table.

If you click Use Point Group, you must specify a Point Group Name and the point group description for the points you wish to use. You can either type the full path (including the drive letter) to an existing point group file or you can click the Browse button and use the file dialog box to specify the Point Group file.

NOTE: In this context, Description refers to the Point Group description, NOT the description for the individual points as found in the coordinate file.

Drawing Operations
In this area of the dialog box you must specify which drawing operations to perform and, if needed, make the necessary settings changes required for the drawing operations. Any settings changes are saved to the drawing and thus remain in effect after this command is completed.

**Plot Points:** Checking this checkbox will cause the selected points to be plotted. Point Settings button: selecting this button will bring up the Drawing Settings dialog box allowing you to make changes to the drawing settings.

**Coordinate Table:** Checking this checkbox causes a coordinate table to be created for the points selected.

**Table Settings button:** will bring up the Coordinate Table Settings dialog box allowing you to make changes to layer, text size and line spacing.

**Draw Lines/Arcs:** Checking this checkbox causes lines and or/arcs to be drawn between the points specified.

**Line Settings button:** Will bring up the Linetype Manager allowing you to select the linetype.

**Draw Breaklines:** Checking this checkbox causes breaklines to be drawn between the specified points. Breaklines are for use in topographic operations (see CGTopo).

**Topo Settings button:** displays the CGSurvey Auto Contouring settings dialog box allowing you to make changes to the current topo settings.

**Draw Calls:** When Draw Calls is checked, calls will be drawn between the points specified.

**Call Settings button:** will display the Call Settings dialog box allowing you to make changes.

**If Use Call Table is checked:** all call information will be placed in a call table, rather than along the line work. The Call Table Settings button displays the Call Table Settings dialog and allows you to set the layer calls will be placed on, the text size, the line spacing, the first course label, etc.

**If Use Curve Table is checked:** all curve information will be placed in a curve table, rather than along the line work. The Curve Table Settings button displays the Curve Table Settings dialog and allows you to specify: which components will be shown in the curve table, which layer the table will go on, the text size, the line spacing, the first course label, etc.

**The Layer Settings button:** displays the Layer Manager dialog. Here you can create any layers you need or set the current layer as required. When you are satisfied click OK.

**If you choose Use Point Group:** the drawing operations you have selected will be completed immediately.

**If you have selected Choose Points Interactively:** enter or pick the desired points at the following standard C&G point sequence command line prompt:

**Note:** When entering the points at the command line, some drawing operations may occur as you enter the points.

**Placement of coordinate, call and or curve tables**
No matter what point selection method you use, if you specified that any tables be drawn, the coordinate, call or curve table will be placed at the cursor and you will be asked to move the cursor to the desired location. Clicking the left mouse button will place the table in the drawing at the cursor location.

Pulldown Menu Location: CG-Survey > CGDraw>Multi-Draw
Keyboard Command: MD, CG_MULTI_DRAW
Prerequisite: Coordinate File and/or Point Group

Plot Points and Symbols

Plot Points on Screen
Plot Points on Screen: This feature plots the selected points from a coordinate file on the screen.

Prompts
Prompts

If a coordinate file is not open, a file dialog box will appear allowing you to open one.
You will then be asked to select the points to be plotted (for additional information, see Getting Started: Coordinate point selection sets).

Type the Capped Letter to initialize the selection Set
[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A

Command: 
Command: 
Command: Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]:
Ready

Press <Enter>3x when done: The points will be plotted on the screen.

In which layer will the points be plotted?

If the Use Description Table for point plotting parameters checkbox is not checked in the Graphic Options tab in C&G Options dialog: then all points will be plotted on the current layer according to the Drawing Settings dialog.

If the Use Description Table for point plotting parameters checkbox is checked and the Default layer for codes or descriptions not found in description table is specified: point's will be plotted to the layers specified by the description table (for a discussion of description tables see the CGMgmt chapter).

Description matches a description found in the description table: the point and its labels will be plotted as specified in the description table. For a description to match it must be a whole word match, disregarding numbers.
For example:
Table Description Point Description Match
TC TC-.5 to Bc yes
SW SW1 yes
FH TOPFH no
If a point has several different descriptions found in the description table: then that point can be plotted in more than one layer. For example: If the point's description is TC WV, it will be plotted in the layer assigned to the description TC as well as the layer assigned to the description WV.

No match is found in description table: the point will be plotted in the default layer with point labels as specified for the active point symbol.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols>Plot Points on Screen
Keyboard Command: PP, CG_PLOT_POINTS
Prerequisite: Coordinate file

Remove Points from Screen
This feature allows you to remove/erase specified points from the drawing.

Prompts
If a coordinate file is not open, a file dialog box will appear and allow you to open an existing coordinate file.

Using the standard C&G Select Points commands, select the points to be removed.

Type the Capped Letter to initialize the selection Set
[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A

Press <Enter> 3X when done: The points will be removed from the screen.

Note: Remove Points from Screen does NOT delete points from the coordinate file.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols
Keyboard Command: RP, CG_REMOVE_POINTS
Prerequisite: Coordinate file

Graphic Scale
This feature allows you to draw a graphic scale. Make sure the correct scale has been specified in the Drawing Settings dialog box.

Prompts
In the CGSurvey Draw Graphic Scale dialog specify the layer for the graphic scale.

Layer: Scale

Once you have specified the layer: press the OK button.

The Graphic Scale symbol will then be drawn at the mouse cursor: You can move the cursor to position the graphic scale then press the left mouse button to place it at the cursor location.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and symbols>Graphic Scale

Keyboard Command: GSC, CG_DRAW_GSCALE

Prerequisite: Coordinate file

Lines and Polylines

Lines by Point Number

This feature allows you to draw lines and/or arcs based on the points in the coordinate file.

Prompts

If you choose this option and a coordinate file is not open, you will be prompted to open one. You will be prompted at the command line to enter the coordinate point IDs that define a line/arc or a series of lines/arcs. You may type the point IDs at the command line or pick points on the screen.

Enter Point Sequence
(point group/Reset/sNap on) (last point = <72>):

Once a point is selected the command line will change to a new group of options
(cLockwise curve/ccW curve/Point group/Reset/sNap on) (last point = <72>):

Once finished plotting points simple hit<Enter> and the command line will clear.

Point Input: When entering a point sequence specifying a line/arc the following input forms are acceptable:

34: Either specifies the starting point of a line or, if this is a continuing series of lines, draw a line from the previous end point to point 34 and occupy point 34.
6-9: Draw a line from point 6 to 9 and occupy point 9.
-4: Draw a line from the previous end point to point 4 but remain at previous end point.
L: Specify a cLockwise curve. The previous end point is assumed to be the PC of the curve. The next point specified is the center or radius point of the curve and the next point entered is the PT of the curve.
W: Specify a counter clockwise curve. The data entry sequence is similar to a clockwise curve.
P: Use a Point group to specify the lines/arcs. You will be asked to pick the point group file using a file dialog box.
R: Reset the "last point" to none
N: Toggles the CAD snap command on or off

If you choose to use a point group file, lines will be drawn from point to point in the order specified in the point group file (see the CGMngmt chapter for information on point group files).

If you do not want to type in the point IDs to define the lines/arcs, you can select the points from points that are plotted on the screen using your mouse. (see Plot Points and Symbols).

Note: To specify an arc to be drawn pick the PC point of the curve then enter either L <Enter> for clockwise or W <Enter> for counter clockwise curve. When prompted, pick the radius point and then pick the PT.

Pulldown Menu Location: CG-Survey > CGDraw > Lines and Polylines > Lines by Point Number
Keyboard Command: LBP, CG_LBP
Prerequisite: Coordinate file

Lines by Description
This feature allows you to connect lines between all the points in a coordinate file having a common description.

![CGSurvey Draw Lines by Desc](image)

Layer: Specify the name of the layer the lines are to be drawn on.

Desc: Specify the description of the points you want to connect. Case is ignored and, unless the checkboxes described below are checked, only the leading characters of the point description are considered for a match.

Match text anywhere in desc: If this checkbox is checked, the entire point description field will be searched for the characters specified in the Desc: edit box. For example:

<table>
<thead>
<tr>
<th>Input Description</th>
<th>Point Description</th>
<th>Match</th>
</tr>
</thead>
<tbody>
<tr>
<td>MH SanMH</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

Prompts
After choosing the Lines by Description menu item you will see the CGSurvey Draw Lines by Desc dialog.
**Force match to be whole word:** If this box is selected, the match must be a complete word in the point description, not just a portion of a word. For example:
Input Description Point Description Match
RD CL RD Yes (whole word)
RD CLRD No (not whole word)

**Connect Mode**
- **Sequential:** Connects the points in point ID order.
- **Closest:** Ignores point ID and connects to the closest point with named description.

**Pull-down Menu Location:** CG-Survey > CGDraw > Lines and Polylines > Lines by Description
**Keyboard Command:** LBD, CG_LBD
**Prerequisite:** Coordinate file

---

**Lines by Codes**
This feature allows you to draw lines between the points in the coordinate file having a common point code. The point code is a two to four character field (depending on the type of coordinate file).

![CGSurvey Draw Lines by Code](image)

**Prompts**
Choosing the Lines by Code menu item brings up the CGSurvey Draw Lines by Code dialog.
With the exception of the Code: field, the items in this dialog are identical to those in the CGSurvey Draw Lines by Desc dialog.

**Code:** field specifies the code for the points you want to connect. Case is ignored.

**Connect Mode**
- **Sequential:** connects line in point ID order
- **Closest:** connect lines in Closet point with named description

**Pull-down Menu Location:** CG-Survey > CGDraw > Lines and Polylines
**Keyboard Command:** LBD, CG_LBD
**Prerequisite:** Coordinate file

---

**Polylines by Point**
This feature works very similar to the Lines by Point feature described in the previous pages. In Polyline by Points data entry is similar to Lines by Point except Reset does not apply to a polyline. The C&G Polyline allows you to treat road centerlines and other similar things that would normally be made up of several line segments, as one
entity. You can use a C&G polyline to create a point group or you can place calls along it. You could also use a C&G polyline as the bounding polygon in the Fit Structure feature.

**Pulldown Menu Location:** CG-Survey > CGDraw > Lines and Polylines > Polylines by Point  
**Keyboard Command:** CGP, CG_POLY  
**Prerequisite:** Coordinate file

---

**Fit Polylines**

This feature allows you to use a variety of best fit methods to smooth an existing polyline.

---

**Prompts**

First you must choose the method to use in fitting the selected polylines at the following prompt:

_Type of fit to apply:_ [Decurve/Fit/Quadratic spline/cubic spline/C_spline]<C>:

Next, select the polylines you wish to fit then press the <Enter> key or right mouse button to apply the fit to the selected polylines.

**Decurve:** This will decurve a previously smoothed polyline.

**Fit:** uses CAD fit - a series of interconnected circular arcs.

**Quadratic spline:** Uses a quadratic spline curve fitting algorithm.
Cubic spline: Uses a cubic spline curve fitting algorithm.

C&G Spline: Creates a smooth curve that passes through all vertices.

Pulldown Menu Location: CG-Survey > CGDraw > Lines and Polylines > Fit Polyline
Keyboard Command: FITP, CG_FIT_POLY
Prerequisite: Coordinate file
Calls

Place Calls

This feature allows you to annotate C&G and CAD lines, arcs and polylines.

Call Setup

Selecting Calls Setup will brings up the Call settings dialog box.

Desired Call Components: Specify the desired components for the call.  
Bearing and Distance (or Arc and Radius)  
Bearing (Arc)  
Distance (Radius)  
Bearing over Distance (Or Arc over Radius)  
If you specify points to form a curve then the components shown in parentheses will be used to form the call text.  

Format and location: Specify how you want the call placed relative to the line or arc:  
Parallel: to the line or Arc  
Perpendicular: to the line or arc  
At Cursor: means the call text will be drawn horizontally at the cursor and you must move it to the desired location then left click to place it.  
Place Call to Right of Line: If you are placing a call either parallel or perpendicular to a line or arc, select this box if you want the call placed to the right of the line or arc, assuming you are standing on the line and facing in the direction of the bearing. The call will be centered along the line or arc.  
Use the Foot Abbreviation [ ’ ] in Distance Text: Checking this box will places the [ ’ ] mark after the distance (125.36'). Un-checking the box will remove the [ ’ ] mark (125.36).

Line Bearing Direction to:
Selecting NW,NE: will force all calls to be shown only with NE and NW notation (N 428 35’ 12” E or N 168 25’ 31” W)
Selecting SW,SE : will force all calls to be shown only with NE and NW notation (S 428 35’ 12” E or S 168 25’ 31” W)
If < no preference >: is selected the software will define the bearing based on the direction of the points selected.

Layer Name for Call Text: Specify the layer where you want the calls placed.

Automated Placement of Calls on Specified Layers

Check the Automate Placement of Calls check box making the options in the dialog active. This routine allows you to select one or more layers to scan for the placement of calls. The scan will look for lines only in the layers you specify even though other layers may be currently displayed.
Choose one or more layers to search: this dialog will display the complete list of layers in the drawing file. You can scroll up and down the list and simple click with the mouse those layers you want to search for lines/polylines.

Types of Lines to Annotate:

C&G Lines and C&G Polylines: refer to lines that have been drawn using the CGDraw command, thus being based on the C&G coordinate file.
CAD lines and CAD Polylines: refer to lines that have been drawn using the CAD Draw command and are not based on the C&G coordinate files.
Example Cell: this display shows you the actual layout as it will appear on you drawing.

Prompts

When you choose the Place Calls menu item and a coordinate file is not already open, you will be asked to open a coordinate file. You will then see the following prompt at the command line:

Enter point sequence: [Point group/Reset/turn sNap on/Setup/polYline] (last point = <none>):
Point Group: If you press P and <Enter> you will be asked to enter a point group and it will be used to place calls automatically.
Reset: Press "R" resets the last point ID to <none>
sNap on or sNap off: Press "N" turns the CAD snaps on or off. When the command starts the AutoCAD snaps are off by default.
The Setup: Press "S" option brings up the Calls Setup dialog box.

 polyline: if you Press "Y" and <Enter> you can then pick a C&G polyline and it will be annotated in the order that the vertices were specified when it was drawn.

Pulldown Menu Location: CG-Survey > CGDraw> Calls> Place Calls
Keyboard Command: CALL, CG_CALLS or CALS, CG_CALLS_SETUP
Prerequisite: Coordinate file

Move Calls
Allows you to move call text and once moved it will not go back to its original location when you use Refresh Screen to refresh calls. The calls will move or change if the point numbers that generated the call change but the position of the call relative to the end points will remain approximately the same.

Prompts

 Select entities: Pick call on screen
 Entities in set: 1
 Select entities: Pick another call on screen
 Move call to desired location.

Pulldown Menu Location: CG-Survey > CGDraw> Calls> Move Calls
Keyboard Command: MCL, CG_MOVE_CALLS
Prerequisite: Coordinate file

Reverse Calls
This feature allows you to reverse the bearing of the call.

Prompts

 Pick a call to reverse: select call bearing on screen
 Pick a call to reverse: select another call bearing on screen
 Pick a call to reverse: select again if wish to continue or
 Press <Esc>: to quit command

Pulldown Menu Location: CG-Survey > CGDraw> Calls> Reverse Calls
Keyboard Command: RCL, CG.Reverse_CALLS
Prerequisite: Coordinate file

Tables
Coordinates
This feature allows you to draw a table containing information related to specified points in the coordinate file then place the table in the drawing by picking the desired location.
When you pick the Table > Coordinate menu item and a coordinate file is not already open, you will be asked to open one. Once a coordinate file is open, then the Coordinate Table Settings dialog will appear. Using this dialog you can configure the following settings:

**Layer:** Specify the layer on which you want the table drawn.

**Text Size:** Enter the text size in inches or centimeters. The text size is the size the text will appear when printed on a page.

**Line Spacing:** Enter the space you want between lines in inches or centimeters. The line spacing is the height of the spacing when the table is printed on a page.

**Note** Northing and Easting will be rounded based on the values specified in the Rounding Options tab of the C&G Options dialog box.

**Note** The point ID, northing, and easting will always be part of the coordinate table. If you want elevations, codes and descriptions shown, make sure they are set to "On" on the Global Settings tab of the C&G Options dialog. Click OK to save the settings and continue the command, this will return the action to the command line. If you click Cancel the command will be canceled.

**Selecting Points for the coordinate table:**
Select the points that will be included in the table using the familiar C&G prompt.

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Elev/Pt_group/Limits/Radius/Select]: A

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Elev/Pt_group/Limits/Radius/Select]: A

Expand base selection set: Choose more points from coord file. (Enter when done)
[All/Block/Code/Elev/Pt_group/Limits/Radius/Select/Include/eXclude/View]:
Building Point Selection Set...

Press Enter 2 more times to end selection set: <Enter>

When done selecting points just press <Enter>: The table will be drawn at the cursor.

Move Coord Table to desired location: Drag the table to the desired location on the drawing and press the left mouse button to place the table.
Call Table

This feature allows you to place the bearings, distances, etc. in a table instead of along the lines and curves in the drawing. This is especially useful when space along the lines or curves is limited. When you use a call table only the course labels are placed along the line or curve to identify it in the table.

When you choose the Table > Call item from the menu the Call Table Settings dialog appears. As with the coordinate table, this dialog box allows you to enter: the layer, text size and line spacing for the call table.

Drawing Settings
Course labels

First course label: The course labels will be based on the First course label setting in the Call Table Settings dialog box. The course label will then be determined by incrementing the last character in the previous course label starting with the first course label.

For example: line1 increments to line2, line3, etc. whereas line_a increments to line_b, line_c, or as in the example above L1, L2 L3, etc.

Automatically increment course label: Check or Uncheck box

This setting will automate the process with selecting point sequence

After configuring the settings in the Call Table Settings dialog:

Ok Button: select OK

Prompts

You will be prompted at the command line to enter the point sequence.
Enter the point sequence by typing point IDs or by selecting C&G points and/or lines on the screen.

Enter point sequence: [cL_ockwise_curve/ccW_curve/Point_group/Reset/turn_Snap_on]

The Reset button: The ‘R’ resets the last point to <None>

When you are done entering calls: press <Enter>
This will end the input process and the call table will be drawn at the cursor.

Move Call Table to desired location: Drag the table and left-click the mouse button to place table on screen. The course description will be placed in the table and on the line or arc in the drawing.

<table>
<thead>
<tr>
<th>Course</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 15°04'36&quot; E</td>
<td>183.84'</td>
</tr>
<tr>
<td>L2</td>
<td>S 85°52'05&quot; E</td>
<td>170.10'</td>
</tr>
<tr>
<td>L3</td>
<td>S 11°44'15&quot; E</td>
<td>163.23'</td>
</tr>
<tr>
<td>L4</td>
<td>S 65°53'25&quot; W</td>
<td>141.06'</td>
</tr>
<tr>
<td>L5</td>
<td>N 66°49'49&quot; W</td>
<td>132.63'</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: CG-Survey > CGDraw > Tables > Call
Keyboard Command: CALT, CG_CALL_TABLE
Prerequisite: Coordinate file
Curve

This feature allows you to Draw a table containing curve information for specified curves.

You will be prompted to open a coordinate file if one is not already open. Once the coordinate file is open, the Curve Table Settings dialog box will appear. The Curve Table Settings dialog allows you to configure the following settings:

**Curve Components**

Check the checkboxes for the curve components that you wish to appear in the table, Radius, Tangent, Arc Length, Chord Bearing, Delta, Degree and Chord.

**Drawing Settings**

Enter the layer, text size and line spacing, and check or uncheck the Use Foot Symbol checkbox.

- **Layer:** CG_Template
- **Text Size:** 0.100
- **Line spacing:** 0.075

**Curve Labels**

Enter the First Curve Label for the first curve

- **First Curve Label:** C1
- **Automatically increment curve label:** check or uncheck the Automatically increment curve label checkbox.

**OK Button:** When done, click OK to begin entering the curve data.
Prompts

You will be prompted at the command line to Enter point sequence

Picked C&G Point [1444]

Enter point sequence

[cLockwise_curve/ccW_curve/Reset/turn_Snap_on] (last point = 1444): L

Enter radius point for curve [Reset/turn_Snap_on]:
Picked C&G Point [1449]

Enter point of tangency (PT) for curve [Reset/turn_Snap_on]:
Picked C&G Point [1448]

Move Curve Table to desired location: Drag Table to desired location and Left-mouse click to place on the drawing.

<table>
<thead>
<tr>
<th>Curve</th>
<th>Radius</th>
<th>Tangent</th>
<th>Length</th>
<th>Delta</th>
<th>Degree</th>
<th>Chord</th>
<th>Chord Bear.</th>
</tr>
</thead>
<tbody>
<tr>
<td>61</td>
<td>42.00'</td>
<td>48.07'</td>
<td>72.26'</td>
<td>98°30'20&quot;</td>
<td>133°38'48&quot;</td>
<td>64.01'</td>
<td>N 79°14'52&quot; E</td>
</tr>
</tbody>
</table>

Note: After entering the PT point for any curve, you can continue entering curve data. However, you should be aware that the PT point is shown as the last point.

If the PT point is not the PC of the next curve then you need to enter "R" for Reset. This allows you to begin the next curve at a new PC, then continue on to enter its radius point and PT.

Pulldown Menu Location: CG-Survey > CGDraw>Tables>Curves
Keyboard Command: CURT, CG_CURVE_TABLE
Prerequisite: Coordinate file

Auto Map

Map allows the user to automate the production of a drawing based on special "mapping codes" included in the descriptions found in the coordinate file. Using this feature can save a great deal of time. This allows the lines and points to be placed in the drawing based on mapping codes without user intervention.

Pulldown Menu Location: CG-Survey > CGDraw>Auto Map
Keyboard Command: MAP, CG_MAP_DRAW
Prerequisite: Coordinate file

Draw

This feature automates the production of a drawing that can contain specific points, lines, arcs and curve fit lines. The draw option also acts as a Cogo function in that it will calculate the PC, PT and radius points of curves and has the ability to calculate points by traversing and intersection.

Prompts

After choosing the Draw command, if a coordinate file is not open, you will be asked to open one.
After opening the coordinate file, you will be asked to select the points you want to map:

Choose initial points for base selection set from coord. file: (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]:

Next, you will be asked whether you want to store elevations at calculated PC, PT, and radius points: When locating items like back of curb you may need to note the beginning and ending of curves. The points located are never exact as far as the beginning and ending of the curve, but when noted in the mapping routine the application will compute a PC, PT and Radius using the best fit routine and you can choose to store theses points or not.

Note: If Auto Point Plot is ON as specified in the Graphic Options tab of the C&G Options dialog, points will be plotted and lines, arcs and/or curve fit lines are drawn when indicated by Mapping Codes found in the point descriptions.

Mapping Codes Used by the Draw feature

The map codes used by the Draw feature must be placed in the description field for each point in the coordinate file that is to be "Mapped".

Below is the list of map codes:
BL - Begin Line
EL - End Line (optional)
CL - Close Figure
PC - Begin Curve (tangent to previous line)
OC - Point on Curve (begin/end non-tangent curve)
PT - End Curve (tangent to next line)
RP - Radius Point
CF - Curve Fit (spline fit to irregular curves)
CC - Compound Curve
RC - Reverse Curve

Mapping Codes can be upper or lower case. The map code MUST be followed by an asterisk and a line description for the line that is being drawn. For example: BL*CURB1, where CURB1 is the line description for the line you are beginning. It is OK to have spaces between the code, asterisk and line description, but it is not necessary.

For example:
Point ID Description
5 BL* CURB1 BL*SW1 WV
6 CURB1
7 SW1 PP
8 PC* CURB1
9 FH
10 PT* CURB1
11 CURB1 SW1
12 OC* SW1
13 SW1
14 SW1
15 SW1
16 OC* SW1
17 CL* SW1
18 BL* CURB1

Important Note: Mapped lines are connected in ascending order by point ID. The point ID's are always saved in the coordinate file in increasing order. Since the coordinate file is used to perform the Map Drawing and the point ID sequence is produced when the raw data is reduced, it follows that the order of field location of the points will determine point ID sequence order when the lines are mapped.

In the sample sequence above:
Point 5 begins two lines, Curb1 and SW1. Curb1 and SW1 are line descriptions. A line description must be a whole word (no spaces). WV (water valve) is not the beginning of a line because an asterisk does not precede it.

For example:
5 BL*CURB1 BL*SW1 WV

The Curb1 line will be drawn from point 5 to point 6 to point 8. This begins a curve tangent to the line from 6 to 8 continuing to point 10. The curve is tangent to the line from 10 to 11. Since point 18 begins a new Curb1, point 11 is the end of the first Curb1 line (the EL code is not required in order to end a line).

A second line (SW1) will be drawn from 6 to 7 to 11 to 12. At point 12 a non-tangent circular curve begins and continues through points on the curve at 13, 14, and 15. The non-tangent curve ends at point 16 and lines continue from 16 to 17 to 1 (the CL code closes the figure). In creating the non-tangent curve from point 12 through point 16, points 13-15 are used by the Map Draw feature in the calculation of the best fit circular curve.

In addition to the lines drawn, the symbol specified for the WV description in the description table (see CGMngmt) will be placed at point 5 and, at point 7, the symbol specified in the description table for the description PP will be drawn.
As demonstrated in the above example, you may combine multiple codes and line descriptions within a single point description.

For example:
Point ID Description
20 BL*SW1 BL*CURB1 CURB2 EL*CURB3 CL*CURB4

In this example point 20 begins the SW1 line and the CURB1 line. It continues the CURB2 line. It ends the CURB3 line and it closes the CURB4 line.

The Begin Line Code:
All lines must start with a BL code. No lines will be connected to a point unless a word in the point description matches a BL* line name.

The Close Line Code: The close line code (CL) causes the Draw Map feature to connect the CL point to the BL point. You can also use the CL command to traverse. Thus you may place dimensions after a CL command. For example:

**Point ID Description**
20 BL*BLD1
21 CL*BLD1+10.1+10.2-20.3+50.6 EL*SW1

**Note:** The FC-48 data collector does not allow '+' characters in description field. Because of this, the '/' character can be used instead of the '+' character in all the CL examples.

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

<table>
<thead>
<tr>
<th>Occupied Pt BS Pt Angle Distance New Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>21 20 90 10.1 100</td>
</tr>
<tr>
<td>100 21 90 10.2 101</td>
</tr>
<tr>
<td>101 100 270 20.3 102</td>
</tr>
<tr>
<td>102 101 90 50.6 103</td>
</tr>
</tbody>
</table>

Point 103 will then be connected to point 20 to close the BLD1 line. Please note that point 21 is also the end of the SW1 line.

In a CL mapping code sequence, a negative dimension turns -90 degrees from the back azimuth and a positive dimension turns +90 degrees from the back azimuth. Both the '+' and '-' symbols are required but, as noted above, the '/' symbol can be substituted for the '+' where necessary.

This same figure could also be drawn using the following sequence:

**Point ID Description**
20 BL*BLD1
21 CL*BLD1+50.6+

**Note** that the closing distance was not included in the description sequence. See the following examples.

If you have located two corners of a rectangle, you may use the following short cut:

**Point ID Description**
20 BL*BLD1
21 CL*BLD1+50.6+

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

**Occupied Pt BS Pt Angle Distance New Point**
21 20 90 50.6 100

Point 101 will be calculated by a bearing-bearing intersection. Then point 101 will be connected to point 20. The first '+' sign determines the direction used to calculate point 100. The description ending in a '+' sign has the same effect as ending in a '-' sign: if there is no dimension after the last '+' or '-' sign, the last point will be calculated by a bearing-bearing intersect.

If you have located three corners of a rectangle, you may use the following short cut to define the lines to be drawn:

**Point ID Description**
20 BL*BLD1
21 BLD1
In the above example lines will be drawn from point 20 to 21 to 22. The missing corner will be calculated using a bearing-bearing intersect and stored. As noted earlier, ending in a ‘-’ sign instead of a ‘+’ sign has the same end result.

### Curve Codes

Anytime a circular curve is encountered, 3 new points may be calculated and stored in the coordinate file. These points are the PC, PT and radius point of the curve. It is necessary to calculate these points during automated mapping since the field points are only approximations of a perfect curve. They will automatically be assigned point numbers (regardless of the Auto Point Numbering setting). The points calculated during automated mapping of curves will begin with the coordinate files current high point number plus 1.

If the beginning of a line is also the beginning of a curve, one of the following formats must be used:

**Point ID Description**
- 10 BL*SW1 CF*SW1 (begin a curve-fit line)
- or 10 BL*SW1 OC*SW1 (begin a non-tangent circular curve)
- or 10 BL*SW1 PC*SW1 (begin a tangent circular curve)

Once a curve has begun, all matching line descriptions will be considered points on the curve until the curve is ended. A curve is ended with either a PT*, OC*, or CF* code.

For Example:

**Point ID Correct Sequence Incorrect Sequence**
- 10 OC*SW1 (Begin SW1)
- 11 SW1 OC*SW1 (will end SW1)
- 12 SW1 OC*SW1 (will end SW1)
- 13 SW1 OC*SW1 (will end SW1)
- 14 OC*SW1 (End SW1)

The first OC begins the curve. The next OC ends the curve. All the points between them are on the curve. The same is true for curve fit (CF*).

If a curve is either tangent (in), tangent (out) or tangent (in) & tangent (out), you only need two points to define the curve:

**Point ID Sample 1 Sample 2 Sample 3**
- 10 PC*CURB1 PC*CURB1 OC*CURB1
- 11 PT*CURB1 OC*CURB1 PT*CURB1

Otherwise you will need at least three points on a curve:

**Point ID Description**
- 12 CF*CURB1
- 13 CURB1
- 14 CF*CURB1

### The RP Mapping Code

If you use the RP code (radius point), it will be used regardless of the number of points on the curve. The radius will be calculated by averaging all the distances from the radius point to the points on the curve.

Best Fit Circular Curve Calculations
If you have three or more points on a non-tangent curve, the best-fit curve solution is used to find the radius point.
If you have three or more points on a tangent curve (either tangent in, tangent out, or tangent in and out), the best-fit
curve solution is used to determine an approximate radius and radius point. A dummy point is then calculated on the curve and a curve is drawn that goes through the dummy point and meets the tangent criteria (the PC and PT points are shifted up/down the tangent lines as necessary). If only three points are located, PC, POC and PT, the curve will always go through the POC point.

If you have only two points (PC and PT) on a tangent curve, the tangent lines from the PC and PT will be intersected to find the PI of the curve. The distance from the PI to the PC and the distance from the PI to the PT will be averaged to obtain a tangent distance. A new PC and PT point will be calculated on the tangent line and the radius point will be calculated based on the tangent and central angle.

**Non-Circular Curves**

You may use the CF* code for a non-circular curve fit (splines). The CF code will start a curve fit line. The curve will continue until a second CF* code is encountered, example:

**Point ID Description**
11 CF*SW1
12 SW1
13 SW1
14 CF*SW1

Only use CF to start or end a curve. Notice points 12 and 13 do not have automated mapping codes.

A smooth curve will be drawn through points 11, 12, 13 and 14. No new coordinate points are generated with the CF code.

**Layers and linetypes for mapped lines and curves**

The description table determines the layer in which a mapped line will be drawn. For mapped lines and curves, only the description and layer fields in the description table are used. However, if the default layer is not set, no description table lookup is performed and the line is drawn on the current layer.

For example, assume that the default layer has been set and that the description table contains the following entry:

**Desc. No. Description Layer Name**
5 CURB Road

Since layer "Road" is specified for description "Curb", all lines with descriptions "Curb" will be placed in layer "Road". Numbers are not used in the comparisons: Curb1, Curb2, Curb10, etc. are considered a match for the description "Curb" and will therefore be placed in layer "Road".

If a matching description is not found in the description table, the line is drawn on the default layer (as set in the Graphic Options tab of the C&G Options dialog box).

**Calculated Points**

All coordinate points that are automatically calculated and stored during automated mapping are given a MP point code.

**Note**: Even though the point description field can contain Mapping Codes, the point code found in C&G coordinate files is separate and distinct from the point description field. All points already having an MP Code are ignored by automated mapping. This avoids re-mapping points that were generated during automated mapping and thus were not points actually located in the field.

**Important Note**: Consider the MP point code as a reserved code and do not use it for field data collection.
The description (e.g., CURB) used for calculated points is the same as the line description of the points the calculated point is associated with and reflects the type of calculated point that it is.

For Example:
Assuming the line description for the following points is "CURB1" and the points are the PC, PT and radius point of a curve, then the line descriptions will be:

<table>
<thead>
<tr>
<th>New Point ID</th>
<th>Point Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 MP</td>
<td>PC</td>
<td>CURB1</td>
</tr>
<tr>
<td>101 MP</td>
<td>RAD.PT</td>
<td>CURB1</td>
</tr>
<tr>
<td>102 MP</td>
<td>PT</td>
<td>CURB1</td>
</tr>
</tbody>
</table>

**Plotting of Points**

If Auto Plot Points is "On", all the selected points in the coordinate file will be plotted on the screen during the mapping process. If a default layer is set, each point will be drawn on the layer specified in the description table. The points labels will be configured as specified in the description table. Any point that does not have a description match in the description table will either be drawn on the default layer.

**Pulldown Menu Location:** CG-Survey > Auto Map > Draw  
**Keyboard Command:** MAP, CG_MAP_DRAW  
**Prerequisite:** Coordinate file

**Erase**

The Map Erase feature will find all line, arc, curve fit and point entities created using the Map Draw feature and delete them from the drawing. It will also delete any coordinate points from the coordinate file that were created with the using Map Draw (PC, PT, radius points and close line (CL) points or those points having the point code MP).

**Pulldown Menu Location:** CG-Survey > CGDraw > Auto Map > Erase  
**Keyboard Command:** EMAP, CG_MAP_ERASE  
**Prerequisite:** Coordinate file

**Leaders**

Leaders are used to label features in the drawing. They consist of a line or series of connected line segments with an arrow at one end and a text label at the other end. The arrow size is determined by the symbol size as set in the Drawing Settings - Active Point Symbol dialog.

**Text**

A text leader allows you to draw a series of lines with an arrow at the starting point then specify the text that is to be drawn at the final endpoint of the leader.
Prompts

To draw a text leader:

**Pick start of leader:** Pick the starting position of the leader with the left mouse button:
Picked C&G Point [4]

**To point (Enter to end):** Move the cursor to the next point on the leader and press the left mouse button. The first segment of the leader will be drawn with an arrow placed at the first point picked.

**To point (Enter to end):** As you pick succeeding points, lines will be drawn from the previous point to the current point.

**To point (Enter to end):** When you have picked the final point, press <Enter> or the right mouse button.

**Enter Text for leader:** At the command line, type the text to be placed on the leader and <Enter>.

Sample of Text Leader

**Pick start of leader:** repeats the command

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Text

**Keyboard Command:** TXTL, CG_TEXT_LEADER

**Prerequisite:** Coordinate file.

---

**Coordinate Leader**

This feature allows you to pick a point then draw a leader that is labeled with the coordinates of the point picked.

To draw a Coordinate Leader:

**Prompts**

**Pick the starting point of the leader with the left mouse button:** If you pick a C&G point, the coordinates will be read from the coordinate file, otherwise the graphic coordinates will be used.

**Move the cursor to the next point for this segment of the leader and click the left mouse button:** Repeat until all desired leader segments are drawn.

The coordinates of the first point picked will be drawn near the final point on the leader. The coordinates are rounded based on the rounding specifications in the Rounding Options Tab of the C&G Options dialog box.

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Coordinate Leader

**Keyboard Command:** CRDL, CG_COORD_LEADER

**Prerequisite:** Coordinate file
Point Label

This feature allows you to label a point using a leader instead of the normal point labels. This feature can only be used with C&G points. The leader will display the point ID and, if Elevation and/or Descriptions are "On", the elevation and description will be displayed as well.

Prompts

It is suggested that you first plot the points on the screen with the point labels turned off by setting their point label positions to 0 on the Drawing Settings - Point Label Position dialog. Thus only the symbols will be plotted. Next, in the Drawing Settings tab of the CGOptions dialog box: turn on the items you want to be displayed on the leader.

Now choose the Point Label Leader menu item:

Pick start of leader: Move the cursor to a C&G point and press the left mouse button. Picked C&G Point [3]

To point (Enter to end): Move the cursor to the end point of the next leader segment and press the left mouse button. An arrow will be drawn at the first point picked.

To point (Enter to end): When you have picked the end of the last segment of the leader, press <Enter> or the right mouse button.

To point (Enter to end): The point attributes will be placed near the last point picked for the leader. (You may repeat the previous step as many times as is necessary)

When done press <Enter> when asked to pick the next C&G point, Press Enter

Pulldown Menu Location: CG-Survey > CGDraw>Leaders>Point Label

Keyboard Command: PTL, CG_POINT_LEADER

Prerequisite: Coordinate file

Station-Offset

This Leader feature allows you to label points along a predefined alignment with their station and offset.
Prompts

Prior to using this feature you must create a point group that defines the alignment.

Next you will be asked to open a point group file. In the Select a C&G Point Group File dialog box: select the point group file that defines the horizontal alignment you wish to use.

**Enter starting station** <0.00000>: 1000
10+00.00
Enter Starting station for the alignment as defined by the point group. If a station is specified for the first subgroup name in the point group file, it will be used as the default station (for more details on this, see the section on point group files in CGMngmt).

**Pick the starting location of the leader:** Picked C&G Point [3]
If a C&G point is not found at this location, the station and offset will be calculated using the drawing coordinates of the picked point. If a C&G point is found, the station and offset will be calculated from the coordinates read from the coordinate file. If a C&G point is found, the point ID will be printed at the command line.

**To point (Enter to end):** Move the cursor to the end point for this segment of the leader and press the left mouse button, An arrow will be placed at the first point picked. Repeat until all the segments of the leader have been specified.

**To point (Enter to end):** When you have picked the end point of the last segment of the leader, press the <Enter> key or right mouse button. The station and offset label will be placed next to the end point of the leader.

**To point (Enter to end):** Enter

**Pick start of leader:** Repeats the command

**Note:** The station and offset values are rounded based on the values specified in the Rounding Options tab of the CGTools > CGOptions dialog box

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Station-Offset
**Keyboard Command:** STOL, CG_STA_OFF_LEADER
**Prerequisite:** Point group must be created

---

**Query**

Selecting Query and then selecting a drawing object will display information related to the following C&G entities:

Point symbols and labels
Lines
Prompts

Select entities: (Pick entity on screen) Entities in set: 1
Select entities: (item selected) C&G POLYLINE

Below is an example of a Query listing of a C&G Polyline:

Coordinate File: CGDEMO.CRD (C&G Numeric)
Plotted from Auto Mapping: No
Layer: Boundary
Points defining C&G Polyline: 11->9
Polyline is NOT CLOSED

Pulldown Menu Location: CG-Survey > CGDraw > Query
Keyboard Command: Q, CG_QUERY
Prerequisite: Coordinate file

Drop C&G Attributes

This feature allows you to strip the C&G attribute from any C&G entity. When the C&G attribute is dropped, the graphic entity becomes standard CAD entity and will no longer be affected by the Refresh Screen feature nor can they be used by C&G commands requiring C&G entities as input.

Prompts

Select entities: pick on graphic screen
Entities in set: 1
Select entities: pick again on screen
Entities in set: 4
Select entities: select another set of entities by window
Entities in set: 7
Select entities: Specify opposite corner: 8 total found,
Entities in set: 8

Pulldown Menu Location: CG-Survey > CGDraw > Drop C&G Attributes
Keyboard Command: DROP, CG_DROP
Prerequisite: Coordinate file

re-Associate Coord. file

This routine allows you to associate the current drawing file with different coordinate file than created the drawing file. An example of this could be a phase of a project. The over all project coordinate file might contain 10,000 to 15,000 coordinates, While working on a phase of the over all project a separate, smaller, coordinate file was created, easier to work with a 1000 points rather than 15,000. Now you want to re-associate this new drawing file with the
over all project coordinate file.

Prompts

After selecting the re-Associate command there will be displayed a Warning dialog box. This box recommends that you create a backup of your drawing file. The danger with using this application is if the coordinates are not managed carefully and the same point ID's were used in both the overall project file and the out parcel then the graphics will be incorrect. C&G graphics are based on the coordinate file and if the X/Y/Z values change so does the graphics.

Do you wish to Continue? Press <Y> button: Y
Re-associate only those C&G entities plotted using which coord. file [Any_file] <A>: A

An Additional Warning message may also appear indictating conflicts in linked crd files
Do you wish to Continue? Press <Y> button: Y

Pulldown Menu Location: CG-Survey > CGDraw>re-Associate Coord. file
Keyboard Command: Not available
Prerequisite: Coordinate file
Refresh Screen

Many graphic entities created by CGSurvey contain attributes that tie them to the coordinate file (C&G points, lines, arcs, calls, etc.). Examples would be point numbers, elevations, and descriptions that are plotted with the node when you plot points. However, once an entity is drawn the user is free to move or edit it. Also, it may be necessary to change the coordinates of the point or points used to create the entity.

If C&G entities are edited or the coordinate values change, you refresh the drawing so that it reflects the current coordinate file values. You can use the Refresh Screen feature to find all C&G entities tied to the coordinate file and read the points from the coordinate file and redraw the entities based on the current coordinate values.

Prompts

Check the appropriate boxes in the list to refresh: Press Ok to continue

Do you wish to retain the point symbol size and Label height of the existing points?: Press <Y> button

Below is example of Refreshed screen entities:
Command: cg_refresh
24 Lines refreshed.
2 splines refreshed.
24 Calls refreshed.
24 Points refreshed.
There were 2 C&G polylines refreshed.

Pulldown Menu Location: CG-Survey > CGDraw > Refresh Screen
Keyboard Command: REF, CG_REFRESH
Prerequisite: Coordinate file

CGMngmt

Point Manager
The point manager allows the user to perform most of the normal coordinate file management functions. You can perform whole file operations such as renaming the file, copying or moving the file, etc. There are also point operations which allow the user to add, delete, or change individual points or groups of points in a coordinate file.

The C&G Point Manager dialog (shown below) is divided into three sections. These sections are described below.

![C&G Point Manager Dialog](image.png)

Current Coordinate File Information
This section gives you basic information on the currently selected coordinate file. The Directory and File Name defaults to the currently active coordinate file but you can choose to perform operations on any one of the supported types of coordinate files by clicking the Browse... button. When you click the Browse... button you will see a file dialog allowing you to choose the coordinate file you wish to work on. The Make Current checkbox allows the user to make the specified file the current file. Thus, when the dialog closes, the file will be used for future commands requiring a coordinate file.
File Operations

This section of the dialog allows you to perform operations that effect the entire coordinate file.

There eight operations that can be performed using this section of the dialog (see descriptions listed below). To perform one of the operations on the file shown in the Current Coordinate File Information section, click on the radio button for the desired operation then click the Perform Operation button.

Apply Desc Table

This operation only applies to C&G coordinate files and will not be available for other file types. When you apply a description table to a coordinate file it translates the numeric codes found in the description field using a C&G description table. For each point in the coordinate file having an integer in the description field the program looks for that integer description number in the description table. If a matching description number is found in the description table, the description found in the description table is placed in the description field for that point and the description number is placed in the code field for that point. The point is then stored back to the coordinate file with the changed field values. If no match is found the point is not changed in any way.

Change Desc Length

This operation only applies to C&G coordinate files and will not be available for other file types. When a C&G coordinate file is created, the user is allowed to specify the length of the description for a given point in the file. The description length may be between 1 and 100 characters. This operation allows the description length to be changed. It can be made smaller or larger. If an existing point in a coordinate file has a description that is longer than the new description length, the description will be truncated. When you click the Perform Operation button you will be asked to enter the desired description length (see dialog below).

Change File Type

This operation allows the use to convert among the supported types of coordinate files. The types supported are C&G numeric (*.crd) and alphanumeric (*.cgc), Carlson numeric (*.crd) and alphanumeric (*.crd), Simplicity (*.zak) and AutoCAD Land Desktop (*.mdb). When you select this operation and click the Perform Operation button you will see the Change File Type dialog:
In the **Change File Type** dialog choose the type of file you want the current file to be converted into by clicking on the appropriate radio button. 

**Note:** the radio button for the current file type is greyed out.

After choosing the file type click the **OK** button. Click **Cancel** to cancel the operation.

If you attempt to convert to a file type having point ID length or description length limits that are less than the limits for the file being converted, you will get the following warning:

**Copy File**

Performs a basic file copy. Must be to another directory and/or file name. When you click the **Perform Operation** button you will be asked to specify the copied file name and directory using a file dialog (see below).
Note: by changing the **Save as type**: this command can change the file type when it copies the file. However, if the type of file being copied has maximum allowable point IDs or descriptions that are greater than one or both of those for the file being copied to, you will receive a warning that point IDs and/or descriptions may be truncated (see Change File Type section above).

**Delete File**

Deletes the file listed in the **Current Coordinate File Information** area of the **C&G Point Manager** dialog along with any of its associated files. Before actually deleting the file you must click the **Yes** button in the following dialog.

**Edit File**

Allows the user to use the CGEditor to edit the coordinate file. You may add and delete points or edit any of the fields for an existing point (see the CGEditor section for more information on using the CGEditor)
Move File

Moves the current file to a new location. You will use a file dialog to specify the new location of the file. When moving a coordinate file you may also change the file type by changing the **Save as type**: The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Rename File

Simply renames the file to whatever name the user specifies. You will use a file dialog to specify the new name and location of the file. Thus this command may be used to change the file type and/or move the file to a different directory. To change the file type change the **Save as type**: in the file dialog when you specify its new name. The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Point Operations

You may perform several operations that effect one or more of the points in the current coordinate file in this section of the **C&G Point Manager** dialog. Use the **Points used:** and **Points Available:** lists to help you determine which points or ranges of points you wish to work on.

Add/Delete section

You may use the standard CGSurvey interface or the CGEditor to add or delete points. Choose which one to use using the radio buttons on the right side of the **Add/Delete** portion of the **Point Operations** area.

Add Points

If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).
If you chose to Use the Standard CGSurvey Command, you will see the Manual Coordinate Storage dialog (see below). Fill in the edit boxes as described in Management > Manual Storage

![Manual Coordinate Storage](image)

**Delete Points**

If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).

If you chose to Use the Standard CGSurvey Command, you will see the following prompt at the Command: line:

```
Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Port-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file.
```

**Buttons section**

**Renumber Points**

If you click on the Renumber Points button you will see the Renumber Points dialog:

![Renumber Points](image)

Fill in the dialog (see the Management > Renumber Points section for more details) and click OK to renumber the specified range of points. If you check the OVERWRITE Existing Points checkbox, you will not be warned of any points that are overwritten during the renumbering process.

**Import Points**
You can use this to copy points from another coordinate file into the current coordinate file. If you click the Import Points button you will be asked to specify the coordinate file from which the points are to be imported. After specifying the import file name, you will use the C&G Select Points from: dialog to select which point are to be imported:

![C&G Select Points from: dialog](image)

**C&G Select Points from: <file name> dialog**

**Choose Points** section:

You can select any one of the methods you wish to use to choose the points by clicking one of the methods of point selection in the **Choose Points** section of the dialog. You may also specify whether you wish to **Include** or **Exclude** the points chosen. If you include the points, they will be added to the list from the coordinate file. If you exclude the points, the points chosen will be removed from the list of points previously **Included**. The method of choosing the points is very much like using the

**Choose initial points for base selection set from coord file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]:

prompt. For example, if you choose the **Include** radio button and the **All** radio button then click on the <Add button, all the points in the coordinate file will be shown in the list on the left side of the dialog. If you then choose the **Exclude** radio button and the **Block** radio button, fill in the block of points you wish to remain in the list, then all but these points will be excluded from the list when you click the **Remove** button (see the example dialog below).
When the points you wish to import are all in the list on the left, click OK.

**CAUTION: If the points that are being imported exist in the current coordinate file, they will be overwritten without warning!**

**Export Points** - click the Export Points button to copy points from the current coordinate file into another coordinate file. You will be asked to specify the file to export the points into then, similar to importing points, use the C&G Select Points from: dialog to select the points to be exported. Click OK in the C&G Select Points from: dialog to export the points.

**CAUTION: If the points that are being exported exist in the file they are being exported to, they will be overwritten without warning!**

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)

[All/Block/Code/Desc/Elev/Vt-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file. Note: this prompt is only used if you have the Use the Standard CGSurvey Command radio button set.

**Pulldown Menu Location:** CG-Survey > Management > Point Manager

**Keyboard Command:** cg_pt_mngr

**Prerequisite:** One or more Coordinate files

**Edit Coordinates (CGEditor)**

The user can use the CGEditor to edit an existing coordinate file or create a new one. You can add and/or delete points and edit existing points. The CGEditor has many sophisticated editing tools that make editing fast and relatively easy. Please refer to the CGEditor section of the Tools menu for a detailed explanation of how to use the CGEditor.
Auto Create Points

The purpose of this feature is to create points in the current coordinate file and draw the associated point symbols using coordinate values extracted from existing drawing entities. These drawing entities may or may not have been created with CGSurvey. The user can automatically place C&G point symbols at the vertices, radius points, insertion points, etc. of selected lines, arcs, points, polylines, and point blocks. The coordinates of the newly created points are then saved in the currently open coordinate file.

**Note:** Unless point symbols are picked, the coordinates that are stored will be the coordinates of the CAD entity. In the case of point symbols, the point ID will be read and used to look up the proper coordinates in the current coordinate file.

After picking the Auto Create Points menu item, the Auto Create Points dialog box will appear:

**Entity Types section**

Select the entity types for which you wish to create C&G points. You can check any combination of the available entity types.

When you click the Select Entities button, specifying only certain entities allows you to window a large area but only have points created for the specified types of entities. You may also select individual entities or several groups of entities. After selecting the entities, click the Create Points button to create the points and save them to the current coordinate file.

**Point Blocks**

If you wish to have coordinates created for point blocks (or inserts) and you want the point ID, description and elevation to be set from information contained in the block, the block must have attributes that can be used to obtain these values. When you choose Point Blocks, the following edit boxes in the dialog are activated and must be filled out:

**Block Name:** Specify the name of the blocks you wish to have points created for.

**Point Attribute Tag:** For the block entities chosen, specify the tag name for the attribute of the block contains the point ID. If no point ID attribute is found then the next sequential point ID will be used.

**Description Tag:** For the block entities chosen, specify which attribute of the block contains the description. If descriptions are ON and no description attribute is found then the default description will be used.

**Elevation Tag:** For the block entities chosen, specify which attribute of the block contains the elevation. If elevations are ON and no elevation attribute is found: if the Use Z-Value as Elev is checked, then the Z value of the block insertion point will be used for the elevation of the newly created point; otherwise the specified default elevation will be used.

**Point Creation Information section**

**Starting point number:**

Use this to specify the starting point number. Specifying anything other than the next available point in the coordinate file as the starting point makes it possible that one or more existing points could be overwritten. However, whenever a situation arises that a point in the coordinate file may be overwritten, a dialog box will appear warning you of this and allowing you to decide whether to proceed with the overwrite or not.
Use coordinate point duplication factor:
If this box is checkbox Coordinate point duplication tolerance edit box is activated and you must enter a tolerance for determining coordinate point duplication. This is used to test if a new point that is about to be created is the same as a point already in the coordinate file. If the new point coordinates are within this tolerance the new point will not be created.

Use Z-Value as Elev
Select this box if the entities you select may have a Z value and you want that value used as the point's elevation.

Default Code
If point codes are turned ON, then this value is used as the default Code for all newly created points.

Default Elevation
If elevations are turned ON, then this value is used as the default Elevation for all newly created points.

Default Description
If descriptions are turned ON, then this value is used as the default Description for all newly created points.

Buttons
Select Entities
Press this button to begin selecting the entities for which you wish to create coordinate points. The dialog box will disappear and you will be asked to use the normal entity selection methods to choose the entities to be used for point creation. Just press Enter at the Select Entities prompt when you are done. You will then be returned to the Auto Create Points dialog.

Create Points
After the entities have been selected, press this button to create coordinate points using the entities. Any existing C&G lines, arcs or polylines will be ignored since they already have points associated with them. Non-C&G lines, arcs and polylines will be converted to C&G lines, arcs and polylines.

Prompts
Fill in the dialog box as required (see above explanation).
Select Entities: use the normal entity selection methods to select the entities to use for creating points.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_acp
Prerequisite: Coordinate file.

Manual Storage
This feature allows you to store points in a coordinate file by typing in the values for the point ID, code, northing, easting, elevation and/or description. You also have the option of using the mouse to pick the location coordinates on the screen.

When you choose the Manual Storage menu item:
If a coordinate file is not currently open, you will be prompted to open one.
Next, the following dialog box will appear: Point
When the dialog box first appears, the point ID (Point) field defaults to the next available point ID as set on the General tab of the C&G Options dialog box. If you enter an existing point number in the point field and click on one of the other fields, the values associated with that point number will be retrieved from the current coordinate
file and placed in the other fields. You may edit them if you wish.

Note: If you enter an existing point ID and alter any of the other fields associated with that point then save the point, NO POINT OVERWRITE WARNING WILL BE GIVEN!

North, East and Elevation
There are three different ways to enter coordinate values:
1. You can type in the coordinate values and elevation in the appropriate edit boxes.
2. You can duplicate a points values by entering a ‘+’ sign and a point ID (example: +25) in the North field. When you click on another field, the coordinate values for the specified point will be automatically entered in the North, East and Elevation fields.
3. Or you can press the Pick Coords button. When you do this the dialog box disappears and you are prompted to pick a point on the screen. Once you have picked the desired point on the screen, the dialog box reappears with the coordinates of the selected point entered in the North and East fields.

Note: If you pick a C&G point, the coordinate values will be read from the coordinate file.

Note: The elevation field is only activated if Elevation is ON.

Code and Description
Enter the desired description in the description edit box.

Enter the point code in the edit box. The point code field is a 4 digit alpha or numeric code only used by C&G. When present it can be used as a sorting tool in addition to the description table.

As an example: say that the description table number 25 is defined as 'Sanitary Manhole'. In addition to using 25 from the description table you also have used the code 'AB' for As-Built and 'DS' for design. Now you can build a selection set of all the description 25's, excluding all of the 'AB' codes and the selection set will contain only those points that are Design Sanitary Manholes.

Note: If descriptions are ON and Get Description From Table is checked, then if you enter an integer code in either the Code or Description field, that number will be used to lookup a description in the current description table. If a matching number is found it will be used for the code and the associated description will be used for the point's description. If there is no matching number found in the description table all fields will remain as entered.

Buttons

Store Point: When all the fields are entered, press the Store Point button to store the point in the coordinate file. If Auto Point Plot ON is checked on the Graphics tab in the C&G Options dialog, the point will be plotted as well.

Reset: This button clears all the fields in the dialog box and sets the point number to the next available point number.

Pick Coords <: click this button to use the mouse cursor to pick the point's coordinates on the screen.

Cancel: Press this button when done.

Prompts

Pick coordinates for point ' <point ID> ': use the mouse cursor to pick the coordinates for the point.

Pulldown Menu Location: CG-Survey > Mngmt
Delete
This feature allows the user to delete selected points from a coordinate file.

If a coordinate file is not open, you will be prompted to open one. Select the points you wish to delete, either by picking with the mouse or entering the point sequence at the command line. When point selection is complete, press Enter. A dialog box will come up asking if you are sure you want to delete the points. If you click OK, the points are deleted.

Note: Deleted points CANNOT BE RECOVERED unless point history is turned on. (See Carlson Configure)

Prompts
Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use any of the point ID selection methods to specify which points you wish to delete from the current coordinate file.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_delete_coords
Prerequiste: Coordinate file.

Fix Coords
This feature should only be used if you wish to attempt to repair a damaged C&G coordinate file. A file can sometimes become damaged when the computer is shut down prior to closing the file. It is wise to always keep a backup copy of your coordinate files in case a damaged one cannot be fixed.

Before running this command, try to open the file after closing any other C&G softer that may be running.

When you run this command you will first be warned that only C&G files should be fixed:

When the file dialog comes up, browse to the file you wish to attempt to repair.

If the fix is unsuccessful, you will get an error message otherwise the fix was successful.

Prompts
Use the file dialog to choose the file to be fixed.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** cg_fix_coords  
**Prerequisite:** Possibly damaged C&G Coordinate file

---

### List

This feature allows the user to list all the information associated with selected points in the current coordinate file.  
If **Display at command line On** is checked on the Output tab of the C&G Options dialog box, the information for the selected points is displayed at the command line (press <F2> to view it). Otherwise the output is sent to the print file. If a coordinate file is not open, you will see a file dialog allowing you to open one.

**Note:** To print and/or view the print file after listing the coordinates, choose **Print/View Print File** from the CG-Survey > File menu. This will open a text editor with the print file as the current file. You may view the file or print it using the text editor.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** cg_list_coords  
**Prerequisite:** Coordinate file.

---

### Renumber Points

This feature allows you to renumber the point IDs of a range of points in the current coordinate file. The point IDs will be renumbered sequentially. If the renumbered points have been previously plotted to the drawing, the points will be redrawn to reflect the changed point IDs.

When you choose this menu item, the following dialog box appears:

**Point ID range to renumber:**

Specify the range of point IDs you wish to renumber. Use the Point IDs Used and Point IDs Available lists to help you determine the appropriate range.

**New Starting point ID:**

Specify the new starting point ID for the range specified. The specified range of points will be renumbered sequentially starting with the New Starting point ID.

**OVERWRITE Existing Points**

If you check this check box and, in the process of renumbering the points, the new point ID is the same as an existing point in the coordinate file, the point will be overwritten. However, if you do not check this checkbox and a possible overwrite is detected, you will be informed of the possible overwrite and required to check this checkbox before proceeding. If you do not wish to overwrite existing points, either re-specify the New Starting point ID or click the Cancel button.

To proceed with the renumbering click the **OK** button.

**Note:** this feature will only renumber points in a coordinate file in which all point IDs are numeric. Thus you can renumber the points in Carlson and C&G alphanumeric coordinate files only if all the point IDs are numeric.

---

### Prompts

Fill in the dialog box as specified above.
Transformations

Combined Transformations

The Combined Transformations feature allows the user to translate, rotate, adjust elevation and/or scale the selected points in a specified coordinate file. The user may also specify whether the transformed coordinates replace the values in the current coordinate file or are saved to another coordinate file.

The Combined Transformations menu item brings up the Transform Points dialog box. This dialog is used to configure the transformations that will be applied.

To begin the process, in the Coordinate Files Used area, choose the coordinate file into which the transformed points are to be stored. If you wish to store them in the current coordinate file, you can go on to the next step. However, if you wish to have the transformed points stored to a coordinate file other than current coordinate file, click the Browse... button and use the file dialog to choose the desired destination file.

Next, check the checkboxes for each of the transformations you wish to apply. Then, for each type of transformation to be applied, fill in each item of data in that area of the dialog.

Translate Points

To translate the points check the Translate checkbox, then fill in the data in the edit boxes in this section of the dialog.
The amount that the selected points are translated in the North and East directions is determined by the difference between the northing and easting of the Reference Point and the coordinates specified in the New Northing and New Easting edit boxes.

**Reference Point** specifies the point in the current coordinate file that is to be used as the reference point for the translation. All the selected points are translated in the same manner as the Reference Point. The reference point will be translated by the difference between its current coordinates and those specified in the New Northing and New Easting edit boxes. You can fill in the New Northing and New Easting edit boxes directly or you can enter a point ID in the New Point edit box. Assuming the point ID entered is found in the coordinate file, the coordinates read from the coordinate file will be placed in the New Northing and New Easting edit boxes. You can edit these coordinates or leave them as they are.

**Rotate Points**

If the Rotate check box is checked, the selected points will be rotated according to the specifications in the Rotate Points area. Rotation defaults to rotation by an angle but can be changed by merely clicking on the Bearing or Angle radio button.

Use the Rotate About Point edit box to specify the point in the current coordinate file about which the selected points will be rotated.

**Rotating by an angle**

To rotate by an angle click the Angle radio button. Next, type in the appropriate angle in the Rotation Angle edit box or click the Pick Angle button and pick the desired angle on the screen.

**Rotating by Bearing**

To rotate by bearing, click the Bearing radio button then type in the appropriate values in the Current Bearing and New Bearing edit the boxes or click the Pick Bearing button and pick the desired bearing on the screen. Note: Bearings must be specified using qdd.mm.sss notation, where q is the quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW), dd is degrees, mm is minutes and sss is seconds. Seconds can be specified to 0.1 seconds if desired.

**Adjust Elevation**

If the Adjust Elevation box is checked, the elevations of the points will be adjusted according to the specifications in the Adjust Elevation area. The type of elevation adjustment can be specified by clicking on the Translate or
Scale radio button.

To Translate elevations

The elevations of the selected points will be translated by the difference between the Reference Point elevation and the value entered in the New Elevation edit box. When you enter a point ID in the Reference Point edit box and click on another edit box the New Elevation edit box will be filled out with the current elevation of the reference point.

To Scale elevations

The elevations of the selected points will be scaled by the value entered in the Multiplication Factor edit box.

Scale

If the Scale check box is checked the northings and eastings of the selected points will be scaled according to the specifications in the Scale area of the dialog.

Meters to Feet and Feet to Meters

You can scale the coordinates to convert feet to meters or meters to feet by checking the appropriate check boxes. Using this form of scaling disables the other items in this section of the dialog box.

Other types of scaling:

The Point to Hold is a point in the current coordinate file that will be used to obtain the reference coordinates for the application of the specified scaling factor to the selected points.

Simple Scale - if you choose simple scaling it will calculate the scaled differences in northing and easting between the Point to Hold and each of the points selected for scaling. This scaled difference is found by calculating the difference between the coordinates of the Point to Hold and those of a given selected point and multiplying that times the specified Scale Factor. This scaled difference is then added back to the northing (easting) of the given selected point.
Adjust to Grid - this scaling method uses the Site Elevation (MSL) and the Projection Table Factor to adjust the northings and eastings of the selected points to grid coordinates.

Methods of Specifying Point IDs for the Various Transformations

When specifying a point ID in the transformation data (for example to specify the Reference Point when the Translate checkbox is checked), you may select points using any one of the three options listed below:

1. Type the point ID directly into the edit box provided.
2. Point List: click the Point List button to bring up the Choose Point Blocks dialog. The left pane shows a listing of all the points found in the current coordinate file. Highlight the desired point in the Points Available list then click the Add > button and the point selected will be displayed in the Points Chosen list. In every case you are only allowed to choose a single point. Once you are satisfied with the point chosen click the OK button.

3. Screen Pick: when you click the Screen Pick button the Transform Points dialog disappears and Choose a point: prompt is displayed at the command line. You may type a point ID or pick a point symbol from the drawing.

Chapter 4. CGSurvey Module
Selecting Which Points Will be Transformed

At any time prior to clicking the OK button you may choose the points to be transformed. To do this click the Select Points button. The Transform Points dialog will disappear and you will be prompted to choose the points:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the points to be transformed. When done specifying the points press Enter until the Transform Points dialog reappears.

Transforming the points

To transform the selected points, click the OK button. The points will be transformed and saved to the specified coordinate file.

Prompts

Fill out the Transform Points as described above.

When the Select Points button is clicked the following prompt appears:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the points to be transformed. When done specifying the points press Enter until the Transform Points dialog reappears.

Pulldown Menu Location: CG-Survey > Management > Transformations
Keyboard Command: cg_transformations
Prerequisite: Coordinate file

Best Fit Transformation

Best Fit Transformation is used to transform the coordinates in the current coordinate file using a "rubber sheet" method of transformation.

First the user must .

Add points from the coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using one or more of the available selection methods.

Next, in the Coordinate Transformation dialog the user must choose at least 2 points in the coordinate file that are known (or "fixed") points.
To specify a fixed point, highlight it in the **Points Available** list then press the **Add >** button to copy it to the **Points with Known Coordinates** list on the right. Or, if you wish, you can also specify a known point from the drawing by clicking the **Screen Pick** button and picking a point from the screen or typing a point ID at the command line. After choosing a known point, the following dialog will appear:

The **Add Point** dialog allows you to change the current coordinates of the known point or accept the current coordinates. When done specifying the coordinates of the known point, click the **OK** button.

After a point has been placed in the **Points with Known Coordinates** list on the right, you can edit the values you entered by highlighting the incorrect point and clicking the **Edit Point** button. Or, if you wish, you can remove an incorrect point from the right hand **Points with Known Coordinates** list by highlighting it and clicking the **< Remove** button.

After specifying all the known points, you must specify which coordinate file will be used to store the transformed points. If you wish to use the current coordinate file you need do nothing. If you wish to write the transformed points to a different coordinate file than the one listed in the **Store the Transformed Points in the File:** edit box, click the **Browse...** button and use the file dialog (see below) to specify a new or existing coordinate file. When done choosing a coordinate file, click the **Open** button in the file dialog.
Click the Transform button in the Coordinate Transformation dialog to cause the transformed coordinates to be calculated and stored in the specified file.

Prompts
Add points from the coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using the typical C&G Selection method.

Follow the instructions above to fill out the Coordinate Transformation dialog box.

Pulldown Menu Location: CG-Survey > Mngmt > Transformations
Keyboard Command: cg_crd_trns
Prerequisite: Coordinate file

Copy Coordinates
This feature allows the user to copy a selected set of points from the current coordinate file to itself or to another coordinate file and, optionally, increase or decrease the point ID by a specified number.

First you must choose the points to be copied:

Add points from coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Next, you must specify what value to add to or subtract from the point IDs to form the new point IDs. If you press <Enter> the default is to leave the IDs the same.

Value to add or subtract from point numbers <0>: press Enter to leave the point IDs as they are or enter a positive or negative number.

Next you must specify the coordinate file to which the points are to be copied.
Store coordinates in [Current-file/Existing-file/New-file] <C>: type "C" and Enter or just Enter to copy the specified points into the current coordinate file. Type "E" and Enter to choose an existing coordinate file into which to copy the points or Type "N" and Enter the copy the points to a new file. If you choose either an existing or new file you will use a file dialog to specify the file to use.

The selected points will then be copied to the specified file.

Prompts

Add points from coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Value to add or subtract from point numbers <0>: press Enter to leave the point IDs as they are or enter a positive or negative number.

Store coordinates in [Current-file/Existing-file/New-file] <C>: type "C" and Enter or just Enter to copy the specified points into the current coordinate file. Type "E" and Enter to choose an existing coordinate file into which to copy the points or Type "N" and Enter the copy the points to a new file.

Pulldown Menu Location: CG-Survey > Management > Transformations
Keyboard Command: cg_move_coords
Prerequisite: Coordinate file

Description Tables

Description tables have several purposes. They can be used as a shortcut method of using point codes or numeric descriptions to automatically set point descriptions when points are saved to a coordinate file. (Descriptions have a similar functionality when used in conjunction with the CGEditor)

Note: the description table is only used in conjunction with saving points to the coordinate file if Descriptions are ON and Get Description From Table is checked on the General tab of the C&G Options dialog.

Description tables allow the user to specify many details regarding the appearance of a plotted point when using Auto Map > Draw or Trav > Reduce, or anytime points are being plotted.

Note: the description table is only used in conjunction with drawing points if Descriptions are ON and Use description table for point plotting parameters is checked on the Graphics tab of the C&G Options dialog.

A description number acts as an index into the description table.

When saving a point to the coordinate file and a number is used in a description field, the description table will be searched for that number. If that description number is found, the number in the description field will be replaced with the description in the description table. In the case of C&G coordinate files, the number will be moved to the point code field. If no match is found, the number will remain in the description field.

When plotting points, the description for the point being drawn is compared to the descriptions found in the description table. If a match is found then the point is plotted using the parameters specified in that description table entry.

The items in this menu allow you to create and manipulate description tables. You can create a new empty
description table and edit it. You can edit an existing description table. You can set or close the current description table and set a different default description table to be used in new drawings.

**Pulldown Menu Location:** CG-Survey > Mngmt

**Keyboard Command:** None

**Prerequiste:** None

---

**Create**

This feature allows you to create a new description table. A dialog box will prompt you to name the description table to be created.

Once you have specified the description table to create, you will be allowed to edit the new, empty description table. See Description Table > Edit for a detailed description of how to edit a description table.

---

**Prompts**

Use a file dialog to specify the name and location of the new description table and the Edit Description Table dialog to create the table entries.

**Pulldown Menu Location:** CG-Survey > Mngmt > Description Tables

**Keyboard Command:** cg_create_desc_table

**Prerequiste:** None

---

**Edit**

This feature allows you to edit an existing description table. The following edit dialog box will appear:

**Note:** Editing a description table does not make it the current description table for the current drawing. To make a description table the current one you must choose the Set Current menu item in the Description Table.

**Caution for CG-SURVEY for DOS users:** You may open the older format CG-DOS Description Table. However, when opened, the CG-DOS description table will be converted to the current format and once converted, the description table cannot be converted back to or used by the CG-SURVEY for DOS program.
Description Table File:

Displays the name and location of the description table currently being edited. Pressing the Browse button brings up the Choose a Description Table to Edit file dialog box allowing you to select a description table to edit.

Note about the Browse button: If you are in the editor just after using the create menu item to create a new description table, you should not use the Browse button.

Descriptions list

This list contains a list of all the descriptions in the current description table. You may scroll through the list using the scroll bar on the right or use the scroll bar on the bottom to view the complete description. The list contains one description per line. By clicking on a description in the list its properties are displayed to the right of the list. The list itself contains some of the description's properties but you must click on the specific description you are interested in to view all its specifications. Each row in the list consists of first the description number then the description itself then the symbol and symbol and label height.

Description section

Description Number: This number acts as an index to the description table.

Description: The description you wish to set parameters for.

Auto Map Line Drawing section

If you check the Draw Lines ONLY checkbox then during Auto Mapping (see Draw > Auto Map > Draw) points with this description will not have the point symbol drawn but will be connected by lines if the line drawing codes are used. The Line Type to Use drop down box allows you to choose one of the currently loaded line types for the
lines drawn between points having this description.

**Point Symbol section**

Symbol: The drawing in the box on the left side indicates which point symbol is currently specified for this description. The text next to the symbol drawing is the name of the symbol minus the .dwg ending. This is the symbol to be used when plotting a point having a description matching that specified in this description entry. You may specify any valid block name by first selecting the type of symbol you wish to use: either Carlson or C&G. You can specify any standard C&G or Carlson symbol supplied with the software or create your own custom point symbols. Custom point symbols must be located in either the users Sup directory with the Carlson symbols or with the C&G symbols in Sup\CGPTSYM generally found under C:\Documents and Settings\<User Name>\Application Data\Carlson Software\<Carlson product name>\<CAD version> directory.

You may press the Change Symbol button to view and/or select the desired symbol.

![Choose Point Symbol](image)

**Symbol Layer:** The drawing layer that the point symbol will be plotted on for any point having a description matching that specified in this description table entry.

**Point Labels section**

Point Label Positions
The entries in this area refer to the plotting of Point ID, Description and Elevation labels around a point symbol.

Layer
The Point ID, Description and Elevation layer names can be specified. If none is specified then the current layer will be used.

Position
You can assign the Position of the point number, elevation and description labels in relation to the point symbol.

Valid positions are 0 through 9 based on the numeric keypad on your keyboard. Consider 5 as the location of the center of a point symbol. Labels can be placed around the point symbol just as the other numbers surround 5. You identify the location where you want the label to be placed around the point symbol by selecting the number on the numeric keypad that corresponds to that relative location. The relative positions are also indicated in the list and can be picked directly from the list.

Position 0 - indicates that you do not want the label to be plotted. Position 5 - can only be used for the elevation label. (If you select position 5 for any other label it will be treated as Position 0). If you select position 5 for the elevation label the whole number portion of the elevation will be plotted to the left of the center of the symbol and the decimal portion of the elevation will be plotted to the right.

Whole Places - can be specified for the elevation label only. Decimal Places - can be specified for the elevation label only.

Plot Radial
If Plot Radial is checked, the point labels will be plotted radially from the symbol's center at the Position specified. If plot radial is not selected, point labels will be plotted horizontally.

**Symbol and Label Size section**

**Symbol Size:** The size of the symbol to be plotted for a point having a description matching that specified for this description table entry.

**Label Size:** The height of the point label text. This refers to labeling symbols with point number, elevation and description.

**Units:** Units can be set to **Scale X Symbol Size** or **Literal**.

**Scale X Symbol Size** indicates that the values for **Symbol Size** and **Label Size** will be multiplied by the drawing scale (Specified on the Drawing Settings tab of the C&G Options dialog) to determine the size of the symbol and/or label in actual drawing units.

**Literal** indicates that the specified **Symbol Size** is in actual drawing units and should not be scaled.

**Note:** If the **Units** for a given description is set to **Scale X Symbol Size**, then the symbol size and label height on the printed drawing are interpreted to be in inches if drawing units are set to FEET on the General tab of the C&G Options dialog and centimeters if drawing units are set to METERS or METRES.

**Buttons**

**List:** clicking this button causes the description table to be printed as a report on the command line and to the print file.

**Add/Replace:** click this button to save your changes when you complete a new description or edit an existing description.

**Delete:** click this button to delete the highlighted description. If you delete a description, it cannot be recovered and you will not be allowed to cancel the deletion.

**Exit:** When finished editing, click this button.
Prompts

Use the Edit Description Table dialog to enter or modify descriptions and their drawing parameters.

Pulldown Menu Location: CG-Survey > Mngmt > Description Tables  
Keyboard Command: cg_edit_desc_codes  
Prerequisite: An existing C&G description table or a newly created one (see Create)

Set Current

Allows the user to select the current description table using a file dialog. The selected description table will be active for the current drawing. When Set Current is used the description table name and location are saved with the drawing settings.

Prompts

Use a file dialog to choose the current file.

Pulldown Menu Location: CG-Survey > Description Tables  
Keyboard Command: cg_set_desc_table  
Prerequisite: Existing C&G Description table

Close Current

Closes the current description table. This is saved with the drawing as part of the CG.SETTINGS.

Pulldown Menu Location: CG-Survey > Mngmt  
Keyboard Command: cg_close_desc_table  
Prerequisite: None

Set Default

Allows the user to select the default description table using a file dialog. The selected description table will be saved to the CGSURVEY.OPT file for the current user and used to set the default settings for any new C&G drawings created by the current user.

Prompts

Use a file dialog to choose the default file.

Pulldown Menu Location: CG-Survey > Description Tables  
Keyboard Command: cg_set_default_desc_table  
Prerequisite: Existing C&G Description table

Convert to SurvCE FCL file

This feature allows you to convert a C&G description table to a SurvCE feature code list or FCL file.
If you are using SurvCE and wish to import your C&G description table for use with SurvCE use this feature to create the FCL file then upload it to the SurvCE data collector FCL directory.

If a C&G description table is not currently open you will be asked to choose which file you wish to convert using a file dialog box.

Next, using file dialog, you will be asked to specify the name of the FCL file to create.

When you click OK after specifying the FCL file name, the conversion will take place.

**Prompts**

Use file dialog boxes to pick the C&G description table to convert and to specify the name of the FCL file to create.

**Pulldown Menu Location:** CG-Survey > Mgmt > Description Tables

**Keyboard Command:** CG_CONVERT_DESC_TO_SURVCE_FCL

**Prerequisite:** Existing C&G description table (*.tbl) and its index file (*.tbx).

**Point Groups**

Point groups were formerly called Batch Point Files or point files. These files are text files with the extension pts.

These features allow the user to create or edit a point group. A point group is simply an ASCII text file that contains a list of point IDs that are in a specific sequence. The points in a point group can describe a tract of land, a road centerline, a utility line, a group of lots in a subdivision, etc. - anything that can be defined by a series of points. Point groups can also contain the PC radius point and PT for horizontal curves as well as vertical curve information.

**An example of a point group file:**

If you view a point group file in a text editor like notepad you will see something like this example

**Note:** the text in square brackets does not appear in the file itself - it is only used to clarify this example:

```
LOT 1 [Subgroup description]
  1 [Point 1]
  23 [Point 23, PC]
  +48 [Clockwise radius point 48]
  49 [Point 49, PT]
  50 [Point 52]
  1 [Point 1, back to starting point]
LOT 2 [Subgroup description]
  12 [Point 12]
  24 [Point 24]
  65 [Point 65]
  70 [Point 70]
  12 [Point 12, starting point]
```

The above example illustrates a point group with two subgroups. Each subgroup defines a lot. The last point in each subgroup is optional - you don't need to close the lot boundary by entering the starting point twice.

**Pulldown Menu Location:** CG-Survey > Mgmt

---

*Chapter 4. CGSurvey Module*
Create

There are two ways to create a new point group: you can use this command or you can use the CGEditor. Previous C&G users may prefer to use this command but the CGEditor allows the user the ability to view and edit the point group as it is being created.

If a coordinate file is not open, you will be prompted to open one using a file dialog.

Once the coordinate file is open, the point group file dialog can be used to specify the name of the point group file you wish to create.

Subgroup description <Enter when done>: Enter the subgroup description.
Specify points for subgroup <filename>:
[Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical_curve] <pick polyline>: 
Use any of the available methods, including picking a polyline in the drawing, to specify the point IDs of the points in the subgroup. Remember that, within a given subgroup, you are defining a specific shape or line and thus the points need to be entered as an ordered sequence that properly defines the lot, alignment, etc.
Repeat the steps outlined above until all subgroups and their points have been entered.
To end the command and create the point group file, press Enter twice after specifying the last point in the last subgroup.

Using a Polyline to specify a group of points

If you pick a polyline, the coordinate file is searched for points having northings and eastings that match the x and y coordinates of the vertices of the polyline. If none of the points in the coordinate file match the polyline vertices, then no points are added to the points in the current subgroup. Any points that match are added to the subgroup points and you are prompted for the next point in the subgroup. You may continue using any of the methods of specifying points, including picking other polylines.

Entering a Curve

First type "I" and enter to enter individual points. As you are specifying the individual points in the subgroup you can specify a curve by entering the radius point ID immediately after entering the ID of the PC. The radius point must be indicated by preceding its point ID with a plus sign for a clockwise curve or a minus sign for a counterclockwise curve. The next point ID you enter is assumed to be the PT.

Vertical Curves

If you are creating a point group to define a road alignment, you may wish to enter vertical curve information so that both the horizontal and vertical alignments are defined.

Note: You may find it more convenient to use the CGEditor to enter vertical curve information.

To do this type "V" and Enter at the command prompt. You will see the following prompt:

Vertical Curve 1
[Next/slope-In/slope-Out/Length/pvi-Station/pvi-Elevation]:

For the first vertical curve you must enter five curve components. Enter these five componants by typing the capitalized letter representing the component that you wish to specify, then press Enter. You will be prompted to
You must enter a value for each of the following five required fields:  
\textbf{The slope-In}  
slope-Out  
Length of the vertical curve  
pvi-Station  
pvi-Elevation.

\textbf{Entering succeeding vertical curves}

After entering the information for the first vertical curve, enter \textless N\textgreater for Next. Since the slope in and PVI elevation are determined by the previous vertical curve information, so you need only specify three fields for any additional curves:  
slope-Out  
Length  
pvi-Station

Use Previous and Next to enter and/or change the vertical curve information. You may enter as many as fifty vertical curves. You can press the F2 key at any time to view the prompt history screen, then use the scroll bar on the right to view the entire data entry sequence.

\textbf{Multiple Subgroups}

To place more than one subgroup in a single point group, press Enter when asked to select another point for the current subgroup. This ends input for the current subgroup.

At the \textbf{Subgroup description} \textless Enter when done\textgreater prompt, enter the name of the next subgroup and go on to enter a new series of points, including both horizontal and vertical curve information as needed.

Continue to enter subgroups of points by repeating these steps until all subgroups have been entered.

When you have entered all the subgroups, press Enter until you get the Subgroup Description prompt.

Press Enter at the Subgroup Description prompt to end the command and create the point group file.

\textbf{Prompts}

\textbf{Subgroup description} \textless Enter when done\textgreater: Enter the subgroup description.

\textbf{Specify points for subgroup} \textless filename\textgreater:

[Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical curve] \textless pick polyline\textgreater: use one or more of the available methods to specify points in the current subgroup.

\textbf{Vertical Curve 1}

[Next/slope-In/slope-Out/Length/pvi-Station/pvi-Elevation]: specify which element of the vertical curve you wish to enter or type "N" and Enter to begin entering the next vertical curve.

\textbf{Vertical Curve ##}

[Next/slope-Out/Length/pvi-Station]: after entering the data for the first vertical curve the following curves are controlled by the initial curve. Thus the prompt changes.

\textbf{Pulldown Menu Location:} CG-Survey > Mngmt > Point Groups

\textbf{Keyboard Command:} cg_create_bpf

\textbf{Prerequisite:} Coordinate file
Edit
The Edit Point Groups feature allows you to use the CGEditor to edit/create an existing point group file.

CGEditor General Information

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

The CGEditor can create and/or edit six types of data files used by C&G:

Raw Data Files
Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.

Map Check Files
Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.

Cross Section Files
Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

Template Files
Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.

Point Group Files
Point Group Files are simply a list of point numbers that can define a group of points, a lot or parcel, or an alignment. These are ASCII files and have a .PTS extension.

Coordinate Files
CGSurvey supports many different coordinate file formats:

C&G .CRD/.IDX - C&G numeric coordinate files
C&G .CGC/.CGX - C&G alpha-numeric coordinate files
Note: for further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

Pulldown Menu Location: Management\Point Groups\Edit
Keyboard Command: BPF; CG_EDIT_BPF
Prerequisite: Open Raw File

CGTopo

Topographic Settings
Allows you to view or change the Topographic Settings. See the Topography tab section of the CG Options menu item of the Tools menu.

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_cont_setup
Prerequisite: None

Erase Surface from DWG
When you open a C&G surface (or TIN file, *.tin) it is shown on the screen as a graphic image overlaid on your drawing. You must use the Write Surface to DWG feature to actually create contour polylines, TIN lines, etc. If the surface changes due to changes in elevation or location of points you will want to erase the old surface and write the new surface to the drawing. However, once a surface is written to the drawing, it can be a difficult process to pick out all the surface entities in order to erase them from the drawing. This feature makes this an easy, one step operation.

You can use the items in this menu to erase the various topographic features: the TIN, Main Contours, Intermediate Contours, Break Lines, Include Boundaries, and/or Exclude Boundaries or All topo items.

Note: To erase contour labels use CG-Survey > Topo > Label Contours > Delete Labels

Pulldown Menu Location: CG-Survey > Topo

Tin
This feature erases all the C&G TIN entities found on the TIN layer specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_tin
Prerequisite: None

Main Contours
This feature erases all the C&G main contour polyline entities found on the main contour layer specified on the Topography tab of the C&G Options dialog.
Intermediate Contours
This feature erases all the C&G intermediate contour polyline entities found on the intermediate contour layer specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_interm_cont
Prerequisite: None

All topo items
This feature erases all the C&G topo entities found on any of the layers specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_all_topo
Prerequisite: None

Label Contours
The items in this submenu allow you to either label contour lines with appropriate elevations or remove previously placed contour labels.

Pulldown Menu Location: CG-Survey > Topo

Place Labels
This feature allows you to place the appropriate elevation labels at selected locations on C&G contour polylines. The label is a TEXT entity overlaying a WIPEOUT entity. The WIPEOUT entity serves to create a space between the label text and the contour line and to keep the contour line from showing through the text and obscuring it.

If you have not already done so, please review the contour labeling settings by choosing the CG-Survey > Topo > Topographic Settings menu item. The labels will be created on the Main and Intermediate Contour Label Layers. The Labeling Interval determines which contours are labeled. For example, if the Labeling Interval is set to 2.00, then every C&G contour polyline that you choose having an elevation evenly divisible by 2.00 will be labeled. The Label-Contour Separation Distance: is the space separating the contour line and the start and end of the label text.

Once you have verified the correct settings, choose the Label Contours > Place Label menu item.

At the prompt (see below) use the left mouse button to pick any point that is on one side of the contour line you wish to label.

Pass a line thru the contours to be labeled.
Pick first point on line. [<ENTER> to quit]:

Now, at the next prompt (see below), drag the rubber band line through one or more of the contours you
wish to label and click the left mouse button a second time.

**Pick second point [ENTER to quit]:**

The labeling operation can be repeated as many times as needed, then press Enter to end the command.

**Some Trouble Shooting Tips for Labeling Contours:**

When a C&G surface is opened it is shown only as a graphic image overlying the drawing. Therefore, before you can place labels on the contour lines, the surface must be written to the drawing using the **CG-Survey > Topo > Write Surface to DWG** menu item.

If the labels do not appear on the contour lines you chose, verify the elevation on the contour using the **CAD LIST** command.

Also, try changing the **Labeling Interval** setting on the **Topography** tab of the **C&G Options** dialog.

If the labels still do not appear on the contour lines, look at **Drawing Settings** tab of the **C&G Options** dialog and verify that the **Text Size** is set to a value that is large enough to be seen when viewing the contours.

If the elevation labels are created with an incorrect number of decimal places, check the **Elevation Precision** on the **Rounding** tab of the **C&G Options** dialog under **Text in Drawing**. Use the **CAD UNDO** command to undo the previously placed labels and try again.

**Prompts**

**Pass a line thru the contours to be labeled.**

**Pick first point on line. [ENTER to quit]:** use the left mouse button to pick any point that is on one side of the contour line you wish to label.

**Pick second point [ENTER to quit]:** drag the rubber band line through one or more of the contours you wish to label and click the left mouse button a second time.

**Pulldown Menu Location:** CG-Survey > Topo > Label Contours  
**Keyboard Command:** cg_label_contours  
**Prerequisite:** C&G contour polyline entities in the drawing

**Delete Labels**

This feature allows you to delete previously placed C&G contour labels. C&G contour labels consist of two entities: a **TEXT** entity containing the elevation text and a **WIPEOUT** entity used to hide the contour polyline under the elevation text. While you can delete these using standard CAD commands, it requires several steps and can be tricky. This feature makes deleting these labels a one step operation.

After choosing the **CG-Survey > Topo > Label Contours > Delete Labels** menu item you will see the following prompt at the command line:

**Select contour labels to delete:**  
**Select objects:** use the mouse to pick the label text for the labels to be deleted. Press Enter when done and the labels and their accompanying WIPEOUT entities will be deleted.
Prompts

Select contour labels to delete:
Select objects: use the mouse to pick the label text for the labels to be deleted.

Pulldown Menu Location: CG-Survey > Topo > Label Contours
Keyboard Command: cg_del_cont_labels
Prerequiste: None

CGTools

CG Options

The CG Options menu item brings up the C&G Options dialog, allowing you to view or change various CGSurvey settings or save the currently configured settings to be used as the default settings for a newly created drawings.

There are nine tabs on the C&G Options dialog. Each tab pertains to a catagory of settings:

1. General tab - settings regarding the coordinate file type for new files, units, scale factors, and other general settings.
2. Rounding tab - number rounding settings used for the print file and for text placed in the drawing.
3. Graphics tab - specify when CGSurvey draws points and lines, format of bearings and other graphics related settings.
4. Traverse tab - settings used by all traverse related features.
5. Output tab - specify the name and layout of the print file and how the results of C&G features are displayed.
6. Data Path tab - specify the default path to your data files
7. Drawing Settings tab - specify drawing scale, text size, and details of how point symbols and their labels are to be drawn.
8. Topography tab - specify contouring parameters along with the layers used for the TIN, countour and other topographic entities.
9. Calls tab - specify the componants, format and layer for calls (annotations).

Each of these tabs will be covered in the following sections.

This tab contains a wide variety of settings that apply to almost all of the features found in the CG-Survey menus. These are settings such as Next Point ID, Elevations, State, Arc Definition, Bearings/Azimuths, Coordinate order and more.
Creating New Coordinate Files section

**File Type:** You may select one of the following coordinate file types:

C&G numeric (*.crd)
- point ID can be an integer between 1 and 65,536
- description from 1 to 100 characters

C&G alphanumeric (*.cgc)
- point ID can contain up to 10 characters using any combination of letters and numbers.
- description from 1 to 100 characters

Carlson numeric (*.crd)
- point ID can be any integer containing up to 9 digits.
- description from 1 to 31 characters

Carlson alphanumeric (*.crd)
- point ID can contain up to 9 characters using any combination of letters and numbers.
- description from 1 to 31 characters

Simplicity (*.Zak)
- point ID can contain up to 8 characters using any combination of letters and numbers.
- description from 1 to 28 characters

Land Desktop Format (*.mdb)
- point ID can contain up to 255 characters using any combination of letters and numbers.
- description from 1 to 255 characters

**Description Length:** This value can only be set for C&G coordinate files. It becomes the default description length for new C&G coordinate and C&G raw data files. It can be set to from 1 to 100 characters.

Current Coordinate File section
Elevations ON If this checkbox is checked, elevations will be carried on all points computed and/or you will be able to enter an elevation when saving a point.

Enter Elev.: If this checkbox is checked, you will be prompted to manually enter elevations.

Calculate Elev.: If this checkbox is checked and an elevation can be computed from the data that has been entered during the command, it will be. Otherwise you will be asked.

Descriptions ON If the Descriptions ON checkbox is not checked, you will not be prompted to enter a description as points are created or edited.

If descriptions are ON, and Get Description From Table IS NOT checked, you will be prompted to manually enter a description for each coordinate point created. However, if Descriptions are on and Get Description from Table IS checked, when a point is stored and a description table IS NOT open, you will be prompted to select a description table. The description table will then be used to look up any integer number in the description in order to substitute the description in the table for the integer and move the integer to the Code files. (see help under CG-Survey > Management > Description Tables)

Point Codes ON If the Point Codes ON checkbox is checked, you will be allowed to enter a two to four character code depending on the number of characters in the code type you are using. This code can be used later to group points with the same code for plotting or listing points. When Point Codes are off, you will not be prompted to enter the point codes.

Automatic Point Numbering ON If the Automatic Point Numbering ON checkbox is checked, as points are created they will automatically be assigned the next available point ID in the current coordinate file. If Automatic Point Numbering is OFF, as points are created you will be prompted to enter their ID. If you enter a point number that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

Scale Factors section

Input: This allows you to set a scale factor that will be applied to all entered distances and coordinate values during any C&G feature.

Output: This allows you set a scale factor that will be applied to all output. For example, if this factor is set to 2.0 and the inversed distance between two points is 100.00, the output will show the distance as 200.00.

Apply Scale to Elevation If the Apply Scale to Elevation checkbox is checked, the Input and Output Scale Factors will be applied to elevation values.

Apply Scale to Coordinate Listings If the Apply Scale to Coordinate Listings checkbox is checked, the Input and Output Scale Factors will be applied to coordinates listed at the command line and in the print file using the C&G feature in menu item CG-Survey > Management > List.

Units section

Angles: Choose either the Degrees or Gradians radio buttons.
Distance: Choose Feet, Meters or Metres from the list.
Note: The only difference in the two metric choices is the spelling used for output.
Foot Definition: Choose either the US or International radio button.

Location section
State: specify the state in which the current survey was done.
This is only used in the following features:

Solar Observation
NAD83 (to and from longitude and latitude)

Hemisphere: Hemisphere can be set to Northern or Southern.
This is only used in the following features:
Solar Observation (Calculating the Convergency Angle)
NAD83 (to and from Longitude and Latitude - UTM only)

Miscellaneous section

Azimuth/Bearing: Allows you choose between Bearing and Azimuth for all direction input and output.

Azimuth Direction: This sets all azimuth input and output to either North or South azimuth.

Curve Definition The Curve Definition can be set to Arc or Chord.
Arc: the most commonly used definition in roadway design. When units are set to Feet, the degree of curve is the central angle of a 100 foot arc length.
Chord: is most commonly used in railroad work. When units are set to Feet, the degree of curve is the central angle of a 100 foot chord.
When a curve is added to a Curve Table or the results of calculations are listed at the command line and in the print file, the displayed information will reflect the Curve Definition setting.

Coordinate Order: Can be set to North-East or East-North. This sets the order in which coordinates are displayed and input.
Allows you to specify the rounding settings for various types of numbers for the print file text and for the drawing text.
Note: All internal calculations are performed with double precision accuracy. Only the output is rounded.

When you select the Rounding tab, you will see the following dialog:
The **Rounding** dialog has a section for **At Command Line and in Print File** rounding settings and a section for **Text in Drawing** rounding settings. Both sections have similar settings but they apply to different output. **At Command Line and in Print File** rounding settings effect all output to the command line and the print file. **Text in Drawing** rounding settings effect numeric text placed in the drawing.

Angular precision can be specified to the nearest:

**Angles in Degrees or Angles in Grads**
- 0.1 Second 0.000001 Grad
- 0.00001 Grad
- 5 Seconds 0.0001 Grad
- 15 Seconds 0.001 Grad
- 30 Seconds 0.01 Grad
- Minute 0.1 Grad

Distance precision can be specified to the nearest:
- Foot (or Meter) 0 (no decimal places)
- Tenth of Foot (or Meter) 0.1
- Hundredth Foot (or Meter) 0.12
- Thousandth Foot (or Meter) 0.123
- Ten Thousandth Foot (or Meter) 0.1234
- Hundred Thousandth Foot (or Meter) 0.12345

The **Graphics** tab settings apply only to CGSurvey features that draw points, lines, etc. to the drawing. When you select the **Graphics** tab, the following dialog will appear:
Point Drawing section

**Auto Point Plot ON** if the Auto Point Plot ON checkbox is checked, points symbols will be drawn as they are calculated and saved to the coordinate file by the various C&G features.

**Use Description table for point plotting parameters** When this checkbox is checked the description(s) for a given point in the coordinate file will be matched with the descriptions in the description table. If a match is found then the description table information will be used to set the layer, symbol type, symbol size, and label positions of each point plotted. If no descriptions in the description table match then the layer will be set to the layer specified in the Default layer for codes or descriptions not found in description table edit box and the other settings specified in the Drawing Settings tab will be used (see below).

If the Use Description table for point plotting parameters checkbox is not checked, the points, symbols and labels will be plotted on the Current Layer as set in the CAD layer manager.

**Default layer for codes or descriptions not found in description table:** When the Use description table for point plotting parameters checkbox is checked, any points plotted that do not have a description or having a description that does not match any of those in the description table, will be plotted on the layer you have specified as the default layer in this edit box.

**Use Elevation as Z Value:** If this checkbox is checked, objects (lines/arcs/points) will be placed in 3-D space with the point elevation serving as the Z-value. C&G features, such as intersects and inverse, ignore the Z-value of lines and arcs. If you inverse a 3-D line, the 2-D distance between the points will be shown. If the Use Elevation as Z Value checkbox is not checked, all objects will be placed at zero elevation.

**Note:** 3D lines can cause problems in trimming or editing using CAD functions. 3D lines do not intersect if their elevations are different. Thus two lines may appear to intersect in plan view but do not actually intersect in 3D space.
Line Drawing section

**Auto Line Plot ON** If the Auto Line Plot ON checkbox is checked, those features that create points that can be interpreted as a line will draw C&G lines.
The following features can draw lines and curves as the points are calculated:
**Quick Traverse** (not to side shots)
**Curve Between Tangents** and **Tangent Between Curves**
**Bearing** and **Hinge/Radial Area-Cut-Off**
**Roadways** (**Right of Way/Easements** and **Intersections/Cul-de-Sacs**)
**Middle Ordinate Solution**
**Best Fit**

**Line Stop Size** This allows you to terminate C&G lines at the edge of the point symbols plotted. If you are drawing lines and/or arcs with a C&G feature that draws lines and you want the line to end before crossing into the symbol, then set the **Line Stop Size** to the symbol size.

**Note:** If you set the line stop to something other than 0.0, the line that is drawn is shorter than the actual distance between the coordinate points. So if you wish to check the true distance of that line, use the **Query** command (on the Draw menu) rather than the CAD LIST command.

Text section

**Arc Annotation Prefix**
This is used when annotating arcs when drawing calls. This should be set to the desired prefix for arc length annotation.
Example:
"Arc =" annotation prefix results in the annotation being
Arc = 256.32

"A =" annotation prefix results in the annotation being
A = 256.32

**Radius Annotation Prefix**
This is used when annotating arcs when drawing calls. Similar to **Arc Annotation Prefix**. This should be set to the desired prefix for radius annotation.

**Leading Space in Bearing**
When the **Leading Space in Bearing** checkbox is checked the bearing text has a space between the N or S and the degrees text (eg, N 85°15'30"E). When left unchecked there is not space (eg, N85°15'30"E).

Miscellaneous section

**Process Descriptions before Displaying:**
This setting will allow you to specify how descriptions are processed prior to being displayed. It allows the removal of all underscores (_) and/or mapping codes. No change is made to the data in the coordinate file.

**C&G Snap** can be set to:
**Off:** No snap.
**POINTS** - Snap to C&G point symbols and labels.
LINES - Snap to C&G lines.
POINTS-LINES - Snap to C&G points and lines.
All C&G functions will use this setting when you are picking point symbols, point labels, lines, and arcs on the screen.

Curve Fit Type

When contouring, the contour lines that are created can be smoothed using one of the following methods:
No Fit - Straight line segments between the points.
Fit - Use the CAD program's standard fit method. Contours may not pass through point symbols having the same elevation as the contour.
C&G Spline - Use the C&G Spline Fit algorithm. Contours are guaranteed to pass through point symbols having the same elevation as the contour.

These settings are specific to traverse raw data entry using the CGEditor and the traverse reduction and quick traverse features.

Raw section

Raw Angle Input
This allows you to specify how you want to specify angles when inputting raw traverse data. The options are: 
Angle, Azimuth or Deflection Angle.

Adjustment Method
You have the following choices for traverse adjustment:
None
Least Squares (NOT network least squares - see SurvNET for that)
Find Bad Angle
Compass
Transit
Note: See the Reduce Traverse feature help section for more details on these methods.

If the Backsight Distance ON checkbox is checked and you entering raw traverse data, you must specify the distance to the backsight at each instrument point. These distances will then be used during the reduction process.

If the Adjust Angles ON checkbox is checked, angles will automatically be balanced prior to traverse adjustment. Angular error will be spread equally between all points. Closure information prior to and after balancing will be displayed at the command line.

If the Balance Elevations ON checkbox is checked, the elevations in a 3-D traverse will automatically be balanced during traverse adjustment. The elevations are adjusted proportional to the length of the traverse legs.

Tolerances section

Horz. Angle.
When comparing multiple angles for a given foresight point from a given instrument point and backsight point, this value will be used as the maximum acceptable angular error. If the difference between any two angles is greater than the acceptable limit, the reduction process will pause and showing the instrument point ID and angle measurements will be displayed at the command line.

Horz. Dist.
When comparing multiple horizontal distance components or measurements to a single foresight point, this value will be used as the maximum acceptable distance difference. If the difference between any two distances is greater than this limit, the reduction process will pause and the instrument point ID and the involved distances will be displayed at the command line.

The horizontal distance tolerance is also used as the maximum allowable difference between the two calculated curve radii at the curve end points. If the difference between the distances from the radius point to the PC point and the radius point to the PT point is greater than this value, the calculations will be terminated with an appropriate error message.

Note: for curves, if this value is set unreasonably low, many curves will produce this error message. If you change the setting to a larger, more reasonable value, the curve can be recalculated and generated without error.

Vert. Dist.
This value is the maximum acceptable elevation difference. It is used when comparing multiple vertical distance components/measurements to a given foresight point from a given instrument point. If the difference between the distances is greater than this limit, the reduction process will pause, showing you the instrument point ID and the involved distances. This only applies to the reduction of a 3-D traverse.

Quick section

Quick Angle Input
This specifies the default angle input mode for the Quick Traverse Feature. This can be changed when using the Quick Traverse feature.
The angle input modes are:
Angle
Deflection Angle
Azimuth
Bearing

If the **Print Traverse Input ON** checkbox is checked, all raw input data will be displayed along with the traverse output. If this checkbox is not checked, only the traverse output will be printed.

If the **Vertical Angles ON** checkbox is checked you will be asked to enter vertical angles with the traverse distances. This can be changed when using the **Quick Traverse** feature.

**Curve Bearing**
This defines how non-tangent curve bearings will be input and can be set to either **Chord** or **Radius** depending on how you wish to define the orientation of non tangent curves.
When set to **Chord** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the PT.
When set to **Radius** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the radius point.
Curve Tables and printed calculations will reflect this setting.

**Traverse Mode**
Sets the default traverse mode for the **Quick Traverse** feature.
It can be set to **Traverse** or **Side Shot** mode.
**Traverse** mode: as a point is created the new point is occupied and backsight the previously occupied point.
**Side Shot** mode: as a point is created the currently occupied point and backsight will be held.

**Common section**

**Instrument Height (HI)**
The value entered for the HI can be either the actual instrument **Elevation** or the distance from the ground to the instrument (**Plus up**). In the latter case the elevation of the point the instrument is over is read from the coordinate file and the instrument height is added to it to determine the instrument elevation.

**Vertical Angle Input** - can be set to one of the following, depending on the type of instrument used:
Zenith: Zero angle up
Nadir: Zero angle down
Transit: Zero angle level
**Note:** If set to Transit, vertical can either be full circle (0 to 360 degrees; 0 to 400 grads) or positive angle up and negative angle down.

**EDM Offset**
Depending on where your EDM is mounted, enter the vertical difference between the center of the scope of the instrument and the center of the beam of the EDM (+ if EDM is above; - if EDM is below). Do not use an EDM Offset for scope mounted EDM's. This offset should only be applied to yoke or azimuth base mounted EDM's.

**Note:** Use of the EDM offset allows you to turn your vertical angles directly to the target. A correction will be applied to all distances and elevations computed from field entries in the Traverse and Quick Traverse routines. Most total stations today have the EDM coincident with the center line of instrument scope. In this case the EDM Offset should be set to zero.

**Note:** When an offset is entered, it is used on all distances in the traverse. If some distances are chained, the correction will also be applied. These shots should be reduced separately with no EDM Offset.

**Distance Components** - This option can be set to allow either **Slope Distance/Vertical Angle** or **Horizontal Distance/Vertical Distance** data entry.
If the **Curvature and Refraction ON** check box is checked, the horizontal and vertical components of all slope distances are corrected for curvature and refraction. If your EDM does not already make this correction, it is recommended that this correction be used when carrying elevations using vertical angles and distances. This tab allows you to specify the name and format of the print file and how it is viewed.

**Print File Name section**

The final results of calculations and other actions performed during C&G command execution will always be printed to this ASCII text file. New information is always appended to this file and never overwritten. The default file name is PRINTER.TXT. It is recommended that you use a name that corresponds with the project you are working on. This way you will have a record of all calculations throughout the project. Use the **New Print File** button to specify a new print file to create. Use the **Existing Print File** button to specify an existing file.

**Print File Viewer section**

You can choose to use Microsoft Notepad or Wordpad when viewing or printing the print file. If you want the viewer to always come up full screen, check the **Force print file viewer to use full screen** checkbox.

**Point Configuration section**

If the **Headings On** checkbox is checked, a heading is printed to the command line and/or the print file any time multi-line output is generated by a C&G feature. The heading information contains date, time, feature name, coordinate file name and input and output scale factors. The header is repeated when the number of lines output by a function exceed the value set for **Lines Per Page**.

If the **Display On** checkbox is checked, the output from CGSurvey features is printed at the command line. Regardless of this setting, output is always sent to the print file.
Printable Columns
Use the edit box to specify the maximum number of characters per line to be written to the print file. This allows you to fit the text to the printed page given the font and paper your uses. The acceptable values are 80 through 255.

Lines Per Page
This allows you to set the number of lines that will be placed on a page. If headings are on, a header will be printed to the print file and the command line each time this number of lines is exceeded.
On this tab you can specify the path to your data files. The data path is the default directory for file dialogs used in various C&G commands that open or save files.
You can type the path in the Data Path edit box or you can use the Browse... button to use a file dialog to specify the data path.

Drawing Scale section
This sets the horizontal scale. For example, if units are set to feet and you want a horizontal scale of 1" = 20' then type 20 in the Horizontal (ft/in) edit box. For metric units, if you want a scale of 1m = 500m then enter 500 in the Horizontal (m/m) edit box.

Text Size section
Allows you to set the text size for any text drawn using a CGSurvey feature. The text size is the size of the text as measured on the plotted or printed page. It must be specified in inches if using feet or centimeters if using meters.
Point Symbol Configuration section

Current Symbol section

This section allows you to control the symbol, its size and how it is scaled (called units here).

Type of Point to be Drawn: There are two point symbol libraries to select symbols from, the C&G and the Carlson symbol libraries.

Using symbols from either the C&G or Carlson symbol library both allow you to use all of the associated C&G features for plotting, sorting, line stops, attribute information, selection, etc. If you choose to use Carlson symbols the Label Position section of the dialog changes somewhat. This will be discussed later in this section.

Select Symbol button

Choosing Select Symbol button will bring up the Choose Point Symbol dialog:

Use this dialog to choose the active point symbol. You do this by highlighting the symbol name in the list on the left or by clicking the symbol image on the right. Symbols CG00 and CGDCA are compatible with LDT/LDD points. The CGDCA symbol is the correct size for a true LDT/LDD point, and should be used if you are also using LDT/LDD.

Symbol Size and Units
There are two options available for specifying symbol size: (Height) X (Scale) and Literal

If Units are set to (Height)x(Scale), then the symbol size entered here is specified as plotted page units (inches or centimeters - depending on whether feet or meters are being used). In this case, regardless of scale, the symbol will always be the same size when plotted. In example above, the symbol is set to .300". At 30 scale the symbol height will be 9 feet in the drawing itself, at 40 scale it would be 12 feet. Thus, in either case, its plotted size will be 0.3 inches.

If Units are set to Literal then the symbol will be drawn in the drawing at the size specified. This setting is often used for inserts such as title blocks, north arrows, company logos, standard notes, etc.

Label Layer Control section

If you check the Separate Layers check box, you can assign each point label to a specific layer. This allows you to see only the labels you want by turning different layers on or off. If this checkbox is not checked, all the point labels will be drawn on the current layer.

Label Position section
C&G Labels:
If the label location is set to 0 <Off> that label will not be displayed when a point is plotted. Only the elevation is allowed to be at the Center position. If you select Center for the elevation label, the whole number portion of the elevation will be on the left side of the insertion point of the symbol and the decimal portion on the right side (example: the elevation 987.23 will be drawn as 987+23, where the plus sign represents the symbol).

If Plot Radial is checked, the point labels will be plotted radially from the symbol's center. If not selected, point labels will be plotted horizontally.

Label Position for Carlson Symbols

In the Point Symbol Configuration section of the dialog you have the option to plot C&G symbols or Carlson symbols. When the Carlson symbols are used, the Label Position portion of the dialog box changes to display the Carlson method for defining label positions (see below). These "label positions" are actually pre-defined blocks with a predefined location and orientation for the attributes (or labels). There are ten blocks available. The available blocks are identified by the numbers 0 through 9.

Note: when Carlson point symbols are used, the Sample drawing is only approximate - the actual layout will look slightly different when drawn.

Label Format section
Label Height: this is the text size in inches/centimeters when Units are set to (Height) x (Scale) or feet/meters when Units are Literal. The Label Height is used for all three labels: point number, point description, and point elevation.

Number of description characters to show: Depending on the type of coordinate file being used, here may be as many as 255 characters in the description field. This option allows you to truncate the description at a given number of characters.

Elevation: This sets how many characters are displayed before and after the decimal point. On a flat piece of property 2 placed before the decimal may be enough information. On a steep mountain site 3 or 4 decimal places may be needed.

Topography tab

NOTE: The information on this tab is used for items on the CGTopo menu which has limited functionality and does not allow you to create a TIN. You must use the Carlson features to make, use and manipulate TINs (see Surface menu). These settings may be used when opening a CG-SURVEY for DOS drawing (*.PL1) when it has topo data in it.

The items on this tab allow you to specify contouring parameters and Tin, countour and other topographic entity layer specifications.

This dialog allows you to specify the drawing layers for the various topographic entities, as well as set various parameters for the creation of a new surface and placement of contour elevation labels.

Layer Names section
In this part of the dialog you can specify the layers for the various previously existing topographic entities found in the drawing. These allow you to label contours and, if necessary, remove contours and/or labels from the drawing.

**TIN Layer:** Specifies the layer on which triangulation network lines or TIN are found.

**Main Contour Layer:** Layer on which main contours are found.

**Intermediate Contour Layer:** Layer on which intermediate contours are found.

**Main Contour Label Layer:** Elevation labels for the main or index contour lines will be drawn on this layer.

**Intermediate Contour Label Layer:** Elevation labels for the intermediate contour lines will be drawn on this layer.

**Note:** The last two Contour Label Layer names will be used when labeling contours.

### TIN and Contour Parameters section

**TIN Interpolation Range:** The interpolation range determines which points will be joined to form the triangles in the TIN. (MAY be used converting a CG-SURVEY for DOS PL1.)

**Contour Interval:** (MAY be used converting a CG-SURVEY for DOS PL1.)

### Labeling Parameters section

**Label Interval:** When labeling contours, only the contours falling on this interval will be labeled. For example, if you enter a 10' interval, only the contours at 900, 910, 920, etc will be labeled.

**Label-Contour Separation Distance:** This is the space between each end of the elevation label text and the contour line being labeled. A separation distance that is too small can make the elevation label hard to read, while a separation distance that is too large may not be visually pleasing.

This tab gives you several options for specifying the call or annotation format.
Desired Components section

The dialog allows you to specify what you want displayed for a given call and whether the call text is stacked. The text in parentheses indicate the call items for a curve.

Format and Location section

The allows you to specify whether the call is placed Parallel to Line, Perpendicular to Line or requires the user to pick the location for horizontal call text (At Crosshair). If the Place Calls to Right of Line checkbox is checked the calls will be placed on the right side as determined by standing at the first point picked or the first point in a C&G line and looking toward the second point. You may also specify whether to use the foot symbol when units are feet. If bearings are being used, you may specify whether to limit bearing text to NW, NE only or SW, SE only or <no preference>.

Layer name for call text:

Specify the layer the call text is to be drawn on.

Automated Placement of Calls on Specified Layers section

This section of the dialog sets the parameters for a feature that allows you to place calls on C&G and/or CAD lines and/or polylines found on specified layers. To use this option, check the Automate Placement of Calls checkbox. Choose one or more layer names from the list of layer names. You can specify multiple layers by holding the Ctrl key down while picking the layers to search.

In the Types of Lines to Annotate section, check the types of entities you wish to annotate.

Example Call section

The of the tab allows you to see a good approximation of how the call will look when drawn.

OK - click the OK button to save all the settings and close the dialog.

Cancel - click the Cancel button to close the dialog and discard any changes.

Set As Default

Click this button to save the settings to the CGSURVEY.OPT file. These settings will then be used whenever a new CGSurvey drawing is created.

Note: You can set the default settings and not affect any of the settings for the current drawing by clicking the Cancel button after clicking the Set As Default button.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_options
Prerequisite: None

Copy Entity to Layer

This feature allows you to easily copy a single entity or group of entities from one layer to another.

Choose entities to copy:
Select entities: use the standard CAD selection methods to choose one or more entities to be copied. Once you have selected the entities press Enter.

Next use the Layer Name dialog to choose the layer to copy the entities to:
Prompts

Choose entities to copy:
Select entities: use the standard CAD selection methods to choose one or more entities to be copied.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_copyent
Prerequisite: None

Layer Control

These routines allow you to freeze, thaw, restore, turn on and off, and set the current layer without having to open the CAD layer manager.

Pick Layers to Freeze

This feature allows you to freeze layers by picking entities that are on layers you wish to freeze. You may pick as many entities as you wish.

Prompts

Select object on layer to FREEZE.
Select entities: choose objects on the layers you wish to freeze. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lfreeze
Prerequisite: None

Pick Layers to Thaw

This feature allows you to thaw frozen layers by picking entities that are on a layer you wish to freeze. All frozen layers are turned on while you pick the entities. You may pick as many entities as you wish.

Prompts

Select object(s) on layers to keep THAWED.
Select entities: choose objects on layers you wish to thaw. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lthaw
Prerequisite: None
Freeze ALL Layers
Choosing this menu item causes all layers, except the current layer, to be frozen.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_alfreeze
Prerequisite: None

Thaw ALL Layers
Choosing this menu item causes all layers to be thawed.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_althaw
Prerequisite: None

Pick Layers to turn Off
This feature allows you to turn off layers by picking entities that are on layers you wish to turn off. You may pick as many entities as you wish.

Prompts
Select object on layer to turn OFF. choose objects on layers you wish to turn off. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_loff
Prerequisite: None

Pick Layers to turn On
This feature allows you to turn on layers by picking entities that are on layers you wish to turn on. All layers will be turned on during the command to allow you to pick the desired entities. You may pick as many entities as you wish.

Prompts
Select object(s) on layers to keep ON.
Select entities: choose objects on layers you wish to turn on. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lon
Prerequisite: None

Turn OFF ALL Layers
Choosing this menu item causes all layers, except the current layer, to be turned off.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_aloff
Prerequisite: None
Turn ON ALL Layers

Choosing this menu item causes all layers to be turned on.

**Pulldown Menu Location:** CG-Survey > Tools > Layer Control
**Keyboard Command:** cg_alon
**Prerequisite:** None

Pick Current Layer

This feature allows you to pick an entity that is on a layer you wish to make the current layer.

**Prompts**

**Set Current Layer - Select entity on the desired layer:** pick the entity which is on the layer you want to make the current layer.

**Pulldown Menu Location:** CG-Survey > Tools > Layer Control
**Keyboard Command:** cg_lset
**Prerequisite:** None

Elevations

If this menu item is checked, then point elevations are ON. If it is unchecked then point elevations are OFF.

When point elevations are ON and the Enter Elev. radio button is set on the General tab of the C&G Options dialog, you will be prompted to enter an elevation when new points are saved to the coordinate file. When point elevations are ON and the Calculate Elev. radio button is set you will not be prompted to enter an elevation. When point elevations are OFF, no elevation is stored when coordinate points are saved to the coordinate file.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_tog_elev
**Prerequisite:** None

Descriptions

If this menu item is checked, then point descriptions are ON. If it is unchecked then point descriptions are OFF. Generally, when point descriptions are on, you will be prompted to enter a description when new points are saved to the coordinate file. Also, when descriptions are ON, the description field will be enabled when editing coordinate point values.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_tog_desc
**Prerequisite:** None

Point Code

If this menu item is checked, then point codes are ON. If it is unchecked then point codes are OFF. Point codes are unique to C&G coordinate files that can be used to filter or group points in various C&G features.

When point codes are ON, you will be prompted to enter a point code when new points are saved to the coordinate file. When point codes are OFF, no code is stored when coordinate points are saved to the coordinate file.
**Auto Point Number**

If the Auto Point Number menu item is checked then automatic point numbering is ON. This means that, as points are created they will automatically be assigned the next available point ID in the current coordinate file and will be saved without any user interaction.

When auto point numbering is OFF, as points are created you will be asked to enter the point ID. If you enter a point ID that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

See also: Automatic Point Numbering ON checkbox on the General tab of the C&G Options dialog.

**Auto Point Plot**

If the Auto Point Plot menu item is checked, when a point is calculated and stored in the coordinate file it will be plotted in the drawing.

See also: the Auto Point Plot ON checkbox on the Graphics tab of the C&G Options dialog.

**Auto Lines**

If the Auto Lines menu item is checked, automatic line plotting is ON. When automatic line plotting is ON, the following COGO features will automatically draw lines and curves using the newly calculated points as they are saved to the coordinate file:

- Quick Traverse - but lines will not be drawn to side-shots
- Curve Between Tangents and Tangent Between Curves
- Bearing Area Cut-Off
- Hinge/Radial Area Cut-Off
- Roadway (Right-of-way and all Cul-de-Sacs and Intersections features)
- Middle Ordinate Solution for curves
- Best Fit

See also: Auto Line Plot ON checkbox on the Graphics tab of the C&G Options dialog.
CG Snap

C&G Snaps are object snaps that are active only during a C&G command. These snaps allow you to pick point symbols and/or C&G lines by clicking near them. They work similar to the CAD snaps but only snap to C&G entities. The C&G snaps work in conjunction with the normal CAD snaps but, when a C&G command is run, the CAD snaps are automatically turned off at the start of the command and the C&G snaps become active. In almost all C&G features you have the option of turning the CAD snaps back on if desired. When both the CAD and C&G snaps are on, the CAD snaps are applied first to determine the x and y screen coordinates of the point on the appropriate CAD entity; these coordinates are then passed to C&G and they are used to apply the C&G snaps and find the nearest appropriate C&G entity.

Note: If CAD snaps are turned on during a C&G command and if C&G snaps are also on, a double snapping process occurs. Because of this double snapping, it is recommended that when C&G Snaps are on, CAD snaps should be left off during C&G commands.

Note: If snapping is desired and C&G snaps are off, then the CAD snaps must be turned on each time a C&G command is run.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: None
Prerequisite: None

Off

This turns off all C&G snaps.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_snap_off
Prerequisite: None

Points

This allows you to pick near and snap to a C&G point symbol whenever a point ID is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_snap_points
Prerequisite: None

Lines

This allows you to pick near and snap to a C&G line whenever a bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_snap_lines
Prerequisite: None

**Points and Lines**
This allows you to pick near and snap to a C&G point or line whenever a point ID, bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_snap_points_lines
**Prerequisite:** None

**Zoom to Point ID**
This feature pans the drawing in order to place the location of the point ID you specify at the center of the screen. It is not necessary to plot the point symbol prior to using this feature.

**Prompts**

**Point ID of point to zoom to:** specify the point ID of a point in the current coordinate file.

The drawing will be panned to center the point and a "rubber band" line will extend from the point to your cursor.

**Stopping to view point [View another/Done] <D>:** Press "D" and Enter or just Enter to clear the rubber band line and return to the CAD command line. Press "V" and enter to specify another point ID.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_zoom_pt
**Prerequisite:** coordinate file

**Windows Calculator**
Selecting this menu item will bring up the standard Microsoft Windows ® calculator.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_cal
**Prerequisite:** None

**CGEditor**

**CGEditor**
The CGEditor is an integral part of preparing files for use for C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

**Types of data files supported**
The CGEditor can create and/or edit four types of data files used by CGSurvey and Carlson.

**Raw Data Files**

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .cgr.

**Map Check Files**

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .cgm.

**Cross Section Files**

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .cew and the index file has the extension .cex.

**Template Files**

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .ctp and the index file has the extension .ctx.

**NOTE:** The CGEditor program sold as part of the stand alone version of SurvNET can only be used to edit raw data files. The CGEditor can be used to create new files or edit existing files. It uses a multi-document interface, so you can edit or view several files of several different types at the same time. The following sections will describe how to open and edit files.

**Opening Existing Files**

To open an existing file, click on the **File** menu then choose **Open** in the submenu. You can then use the Open file dialog box to browse to the desired file. Check to make sure the **Files of Type:** is set correctly. Click on the desired file to highlight it, then click the **Open** button.
Creating Files

To create a new file, use the File menu and choose New and then click on the type of file you wish to create:

- C&G Raw File
- C&G Mapcheck File
- C&G Cross Section File
- C&G Template File
- Coordinate File
- Point Group File

After clicking the menu item for the type of new file you wish to create, a temporary file is created with no data in it and a spreadsheet-like window will open. At this point more menus items will be added to the main menu and, as you will see, the Add menu item will allow you to insert data rows (or records) where you can enter your data.

NOTE: The CGEditor program sold as part of the stand alone version of SurvNET can only be used to edit raw data files.

The CGEditor Menus
Many of the following File menu items will be familiar to experienced Windows users:

**New**: Allows you to create a new file.

**Open (Ctrl + O)**: Brings up the Open File dialog box so you can select and edit an existing file.

**Close (Ctrl + E)**: Closes the current data file. If more than one file is open, the file that is currently being worked on will be closed.

**Save (Ctrl + S)**: Saves the current file.

**Save As**: Allows the user to save the current file to a file having a different name.

**Print (Ctrl + P)**: Allows the user to print a copy of the currently active file.

**Print Preview (Ctrl + W)**: Displays a preview of the file about to be printed.

**Print Setup (Ctrl + u)**: Printer selection as well as page size and layout.

**Exit (Ctrl + Q)**: Exit the CGEditor application.

**Edit Menu**

As with the File menu, the Edit menu is typical of most Windows programs.

Most of the items in the Edit menu require that either a field within a record, or the entire record itself, be selected (highlighted) before clicking the menu item. To select an individual data item (or field) in a data record simply click the field. To select a record (row) simply click in the first field (Type or Row#) for the desired record.

**Undo (Ctrl + Z)**: Undoes the most recent editing action. (you need not have anything highlighted for this item)

**Redo (Ctrl + Y)**: Reverses the most recent undo action. (you need not have anything highlighted for this item)

**Cut (Ctrl + X)**: Cuts the currently highlighted cell or record. You may then use the paste command to put the cut cell or record in another location.

**Copy (Ctrl + C)**: Copies the currently highlighted cell or record. You may then use the paste command to put the
copied cell or record in another location.

**Paste (Ctrl + V):** Allows you to paste any previously cut or copied cell or record to the currently highlighted location.

If entire records are being pasted and only a field is currently highlighted, the pasted records will be inserted above the current record. However, if one or more entire records are currently highlighted, the pasted records will replace the highlighted records.

**Delete (Delete key):** Deletes the currently highlighted field or record.

**Select All (Ctrl + A):** Selects all the records in the current data file.

**Clear (Ctrl + L):** Removes the data from the selected field or record.

**Add Menu**

The Add menu allows you to add a record to the current file. The Add menu item appends the record to the end of the file. The types of records that can be added will depend on the type of file being edited; these record types will be described in more detail in later sections for each type of file you can edit.

**Insert Menu**

The Insert menu allows you to insert a record above the current record. The types of records that can be inserted will depend on the type of file being edited; these record types will be described in more detail in later sections for each type of file you can edit.

**View Menu**

The View menu allows you to turn tool bars on or off. The items listed in the View menu will differ for different types of files. The individual tool bars will be discussed in the sections pertaining to the various types of files that can be edited.

**Standard Tool Bar**

The above figure shows the standard tool bar. The Standard toolbar is the same for all types of files. It allows you to create all the various files that can be edited by the CGEditor. It allows you to open and save files. It allows you to cut, copy and paste and undo and redo as well as print the current file.

**Settings**
The Settings Menu will differ depending on the type of file being edited. But generally contains the settings for the file and the record colors.

**Tools**

<table>
<thead>
<tr>
<th>Settings</th>
<th>Ctrl+Shift+R</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Data File</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Record Color</td>
<td>Ctrl+Shift+L</td>
</tr>
<tr>
<td>Validate Records</td>
<td>Ctrl+Shift+O</td>
</tr>
</tbody>
</table>

The Settings Menu will differ depending on the type of file being edited. But generally contains the settings for the file and the record colors.

**Tools**

The Tools Menu contains a variety of spreadsheet tools, such as find, find next, find and replace etc. The menu will vary slightly for each type of data file and will be discussed in the sections pertaining to the various file types.

**Windows**

This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file.

**Traverse types**

The raw data file can contain data pertaining to one or more traverses. If you will be using SurvNET to process the data, there is no need to delineate separate traverses in the raw data file. However, if you are using the old C&G traverse reduction program, and you want to combine more than one traverse in a raw data file, you will need to use the special traverse code records at the beginning and end of each traverse.

There are three basic types of traverses:

- **Closed Loop Traverse**
- **Closed Traverse Beginning and Ending at Known Points**
- **Open Traverse and Side Shots**

Figures 1, 2, 3 and 4 show illustrations of each of these traverse types. Below each illustration you will also see the accompanying raw data as seen in the CGEditor.

**Closed Loop**

A closed loop begins and ends on the same two points as shown below in Figure 1.
**Figure 1**

**Closed Loop beginning and ending on known points**

Figure 2 shows a closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.
Figure 2

Loop beginning on two known points and closing on an azimuth

Figure 3 illustrates a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point. In this case it is only possible to calculate a linear closure.
Open Traverse

Figure 4 shows an open traverse (side shots).
Figure 4

<table>
<thead>
<tr>
<th>Sc</th>
<th>Inst.Point</th>
<th>Inst.Height</th>
<th>Backsight</th>
<th>Rod Height</th>
<th>Horz.Angle</th>
<th>Slope Dist</th>
<th>Vert.Angle</th>
<th>Foresight</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>IP</td>
<td>5.12</td>
<td>4</td>
<td>0.00000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>FS</td>
<td>5.00</td>
<td>3</td>
<td>113.19430</td>
<td>92.91000</td>
<td>99.15300</td>
<td>9</td>
<td>H&amp;T</td>
<td>IP</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>IP</td>
<td>5.28</td>
<td>3</td>
<td>0.00000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>FS</td>
<td>5.00</td>
<td>3</td>
<td>264.01250</td>
<td>130.44000</td>
<td>91.15210</td>
<td>10</td>
<td>TP</td>
<td>IPF</td>
<td></td>
</tr>
</tbody>
</table>

Note: The data shown in the CGEditor views accompanying the four illustrations include instrument height (HI) and rod height entries. However, if you have elevations turned off, these entries are optional. Also, the examples use single distance and angle entries but multiple measurements are allowed.

In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

**Entering and Editing Traverse Data**

In the CGEditor "Raw Data" refers to unadjusted field traverse data, typically downloaded to the PC from a data collector. C&G raw data files have the extension .CGR.

**Creating or Opening a Raw Data File**

To create a new file or open an existing file click on the File menu then either click on New or Open. If you click on New, another submenu will appear, pick C&G Raw Data File. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an existing file, click on a raw data file (*.cgr). Next, click the Save button for a new file or the Open button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing...
files open as your project demands.

Settings

Before entering any data you should check the current settings. Click the Settings menu item then click Raw Data File to review and/or change the current settings. (See Settings Menu section later in this section.)

Traverse Data Entry

A line or row in the raw data file is referred to as a record and each item of data in a record is referred to as a field. There are several types of records that you may use in a raw data file:

Instrument Point
Foresight
Foresight Tie
Reference Bearing
Coordinate Value
Standard Errors
Control
Measurement
Setup
Elevation
Scale
Loop Traverse
Closed Traverse
Open Traverse
End Traverse
Data on/off
Comment

The type of data required for each of these types of records varies. Some require no data entry and are only "flags" to signify the beginning or ending of a series of records, others require only one field to be filled out, while others require several fields of data.

Adding and Inserting new records

When creating a new file, to begin entering data you must select from the Add or Insert menus to create the first blank record and begin data entry. Depending on what type of record you are editing, when you press <Enter> for the last field in the record, the following record will be added automatically.

Note: If the Add and/or Insert toolbars are not showing, click on the View menu then click on the toolbar you want to turn on.

When you click on one of the Add menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the Insert menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.

Moving from field to field:

While entering data, to move to the next field, press the Enter or the Tab key. To move to the preceding field press the Esc key or both the Shift and Tab keys at the same time.
Insert and Add menus

<table>
<thead>
<tr>
<th>Instrument Point</th>
<th>Ctrl+Alt+P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foresight</td>
<td>Ctrl+Alt+R</td>
</tr>
<tr>
<td>Foresight Tie</td>
<td>Ctrl+Alt+G</td>
</tr>
<tr>
<td>Reference Bearing</td>
<td>Ctrl+Alt+B</td>
</tr>
<tr>
<td>Coordinate Value</td>
<td>Ctrl+Alt+U</td>
</tr>
<tr>
<td>Coords From File</td>
<td>Ctrl+Alt+F</td>
</tr>
<tr>
<td>Standard Error</td>
<td>Ctrl+Alt+S</td>
</tr>
<tr>
<td>Elevation</td>
<td>Ctrl+Alt+I</td>
</tr>
<tr>
<td>Scale</td>
<td>Ctrl+Alt+C</td>
</tr>
<tr>
<td>Loop Traverse</td>
<td>Ctrl+Alt+L</td>
</tr>
<tr>
<td>Closed Traverse</td>
<td>Ctrl+Alt+D</td>
</tr>
<tr>
<td>Open Traverse</td>
<td>Ctrl+Alt+O</td>
</tr>
<tr>
<td>End of Traverse</td>
<td>Ctrl+Alt+N</td>
</tr>
<tr>
<td>Data On/Off</td>
<td>Ctrl+Alt+X</td>
</tr>
<tr>
<td>Comment</td>
<td>Ctrl+Alt+M</td>
</tr>
</tbody>
</table>

Instrument Point records

The first record of a raw data file is often an instrument point. Add or insert a blank record using the menus or toolbars. Fill in the following fields in the new instrument point record:

**Inst. Point:**
Enter the point ID of the instrument point.

**Inst. Height (or HI):**
Enter the instrument height. This may be either the distance from the IP on the ground ("Plus-up") or the actual elevation of the instrument, depending on how the data is to be reduced. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter). If elevations are ON and you leave this field BLANK (zero is a valid height), all measurements taken a this setup will be considered 2D and no elevations will be calculated.

**Backsight:**
Enter the point ID for the backsight.

**Rod Height:**
Enter the rod height. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter).

**Horz. Angle:**
Enter the instrument's initial horizontal angle reading at the backsight. When doing an azimuth traverse, no entry is required here.

**Note:** on doubled angles: Doubled angles require 2 Instrument Point records. Each new instrument setup requires a 0 to the back sight. The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken. The second angle to the foresight is the doubled angle. You may also double angles to side shots.

**Slope Distance and Vertical Angle or Horizontal Distance and Vertical Distance to the Back sight:**
Enter the appropriate distance and/or angle. A blank is assumed to be a zero.
Note: When the Slope Dist/Vert Angle or Horz. Dist/Vert. Dist. column headings are preceded by a **ˆ**, it indicates that a record inserted before the current record (or added after the current record) will have the same type of distance entry mode. For example, if the heading shows Dist and Angle and you insert a record, the new record will be in the Slope Dist/Vert Angle distance entry mode. You can change this by clicking on one of the distance headings to remove or add the **ˆ**. If the **ˆ** is not present it means that the inserted or added record will have the opposite distance entry mode than does the current record.

If, after entering the data in the last field of a given Instrument Point record, you press the Enter or Tab key, a Foresight record will automatically be created. If you want to change this newly created blank Foresight record into an Instrument Point record, press the Esc key. If you are at the end of the file, pressing Esc again to delete last blank record.

**Foresight Point records**

After entering the data for the last field in the Instrument Point record, press Enter. This will cause a Foresight record to be created below it. This record will contain the following columns (the explanations of several of these columns are as described for Instrument Points, only the differences will be noted here):

**Rod Height:**
This column is only active if elevations are on. If elevations are ON and this field is left BLANK, the point will be considered 2D and an elevation will not be calculated.

**Horz. Angle:**
Enter the instrument’s horizontal angle reading at the foresight point. Enter a positive value for a clockwise angle and a negative value for a counter-clockwise angle. This entry may be blank if you are entering only the distance readings to the foresight.

**Slope Dist./Vert Angle or Horz. Dist/Vert. Dist.:**
Enter the distance data for the foresight point.

**Foresight:**
Enter the Point ID for the foresight point.

**Code:**
Enter the code for the Foresight Point. This column is only active if Code is on. (See Settings in this section.)

**Description:**
Enter the description for the Foresight Point. The number of characters you are allowed to enter is set in the Settings under Description Length. If you enter an integer code here and the Translate Raw Descriptions Using Description Table is checked in the Settings and a matching description number is found in the description table, then the description from the table will replace the integer value you entered in the Description field. The integer value you entered will then be moved to the Code field.

Note: Side shots should be placed within the block of foresights immediately following the instrument point record for the instrument point from which they were shot. You may append side shots to the end of a traverse file, but they must be preceded by a begin open traverse record.

**Foresight Tie records**

In some cases, you will need to tie to an existing traverse. You use a Foresight Tie record to do this. This record is used in the reduction process to determine what known point you are tying into. It is necessary if there are side shots taken at the last setup along with the tie point.

In a closed traverse, you must end a traverse by occupying a known point and turning an angle to a second known point. The second known point is the tie point.

**Reference Bearing**

**From Point**
Enter the point ID of the from point.

**To Point**
Enter the point ID of the to point

**Bearing (Azimuth)**

Bearings must be entered in the form Qdd.mmss where Q is the quadrant (1 = NE, 2 = SE, etc), d is whole degrees, m is minutes, and s is seconds (you can specify seconds to the nearest .1 seconds but when you do not wish to specify tenths of a second, a trailing is zero it is not required).

Azimuth is entered as ddd.mm.sss (when the leading d or the trailing s is zero, it is not required)

**Coordinate Value record**

You can use either the Add or Insert menus or toolbars to create a new coordinate record. You can then hand enter known coordinates for a point. Coordinates can be used as a reference point during the reduction process.

**Entering CoordinateValue records from a Coordinate File**

Instead of hand entering coordinate points, you can insert coordinate records from an existing coordinate file. Click the Insert menu, then pick the Coords From File menu item.

**Elevation**

You can specify the elevation for a given point ID using an Elevation record.

**Scale**

You may specify a scale factor in a Scale record. A scale factor is a decimal number. You may enter as many scale factors as you wish. A scale factor will be used until another is encountered. Scale factors should be placed before an Instrument Point record.

**Note:** Multiple Traverses: If you are combining more than one traverse in a single raw data file, you must separate the traverses with special records. After inserting or adding a begin traverse record, you may type in a comment regarding the traverse in the Comment column. You may also specify the order in which the traverses are to be processed by using the first part of the Comment field. Please see Traverse reduction order below for more details.
Note: If you are processing the data with SurvNET, the Scale records are ignored. SurvNET calculates scale factors automatically when working on State Plane coordinates.

**Beginning and/or ending a Traverse**

**Note:** If you are processing the data with SurvNET, Traverse Records (LT, OT, CT, ET) are ignored. Since SurvNET adjusts all data simultaneously, it requires no traverse definitions.

Use **Loop Traverse**, **Open Traverse** and **Closed Traverse** records to delineate multiple traverses within a single file.

**Traverse reduction order**

The order in which the traverses appear in the raw data file is typically not important. Traverses are processed in the order in which they appear in the file. Traverses may be entered in a sequential order or you may embed one traverse within another. However, *if the coordinates computed from one traverse are needed for the reduction of another traverse, then traverse order IS important.* If this condition is true for a raw data file and the traverses have NOT been placed in the raw data file in the correct order, then you need to specify a **Traverse Order Number** for each traverse in the file.

**Note:** If you specify Traverse Order Numbers, the traverses in the file will be reduced in the order of their Traverse Order Numbers.

**Traverse Order Numbers**

Each **Loop Traverse**, **Open Traverse** or **Closed Traverse** comment field can contain a Traverse Order Number.

**Note:** The Traverse Order Number must be an integer and must appear as the first entry in the Comment field separated from the remainder of the comment by a space.

For example, the comment field of a **Loop Traverse** record having a **Traverse Order Number** of 3 should look like this:

3 this is a comment

*If any one Begin Traverse record has a Traverse Order Number, then all Begin Traverse records MUST have a Traverse Order Number. Also, the Traverse Order Numbers in a given file must begin with 1 and continue sequentially. You may not duplicate a Traverse Order Number for any Begin Traverse record in a given file.*

**IMPORTANT NOTE:** Reducing a raw data file having **Traverse Order Numbers** that violate any of the above specifications will have unpredictable results. Error messages during the reduction process may not reflect the fact that improper traverse order numbering is actually the root cause of the problem.

**Loop Traverse**

This record indicates the beginning of a loop traverse. A loop traverse begins and ends at the same point. If you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

**Closed Traverse**

This record indicates the beginning of a closed traverse. A closed traverse ties into known points at both ends. If
you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

**Note:** If you are running a Closed Traverse and tying into a single point, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

### Open Traverse

This record indicates the beginning of an open traverse. An open traverse is a group of side shots. If you wish to add a comment to identify the traverse in some way, use the **Comment** column.

### End Traverse

Signals the end of the data records for any of the traverse types.

### Comment

Inserts a comment line above the current active line. Comment lines are ignored during processing.

### Data On/Off

**Data On/Off** records surround a series of records that are to be ignored during processing by C&G or SurvNET. The first **Data On/Off** record encountered causes processing to skip to the next **Data On/Off** record. Processing continues beginning at the record after the second **Data On/Off** record. This can be used when trying to isolate errors in a traverse.

### The Add and Insert Tool bars

**ADD Tool Bar:** add the various types of traverse records to the end of the current file.

**Insert Tool Bar:** insert one of the various types of traverse records above the current record.

Notice that the only difference between the appearance of the Add Toolbar and the Insert Toolbar above is the check mark in the lower right hand corner of each icon of the Insert Toolbar.

**Toolbar Icon Explanation**

- IP Add/Insert an Instrument Point record
- FS Add/Insert a Foresight record
- FT Add/Insert a Foresight Tie record
- DR Add/Insert a Reference Bearing record
- S Add/Insert a Scale record
- C Add/Insert a known Coordinate point record
- E Add/Insert an Elevation benchmark record
- LT Add/Insert a Loop Traverse record
- OT Add/Insert an nOpen Traverse record
- CT Add/Insert a Closed Traverse record
- ET Add/Insert an End Traverse record
- SE Add/Insert a Standard Error record for Network Least Squares Adjustment (SurvNET) program
- Co Add/Insert a Comment record
**The Least Squares Toolbar**

The *network* icon:  
Selecting this icon will start the SurvNET Network Least Squares program. If SurvNET has already been started, clicking this icon will bring it to the front so you can work with it. (See the Tools menu section and the SurvNET section for additional info.)

The *eyeball* icon:  
This icon brings up a separate window displaying a scaled map of the current raw data file. (See Graphic View under the View menu section)

The *C* icon:  
Clicking this icon hides all Comment records. The Comment records still remain in the raw file, they are just not shown on the screen. You will find that there are some actions you cannot perform when Comments are off.

The *No DO* icon:  
Clicking this icon removes all the Data On/Off records from the raw data file.

**Status bar**

When this menu item is checked, the status bar will display. The status bar is along the bottom border of the CGEditor window. On the left side of the status bar a brief help message is displayed when you hold the cursor over such things as menu items or toolbar icons. It also has indicators that tell you if Caps Lock or Num Lock are turned on and displays the Row/record number that is currently active.

**Graphic View**

Clicking on this menu item brings up a window containing a graphic representation of the traverse. The traverse lines and points are drawn to scale using the data from the current raw data file.
The Graphic View Window

The Graphic View window shows a scaled drawing of the current raw file traverse lines and points. The toolbar icons at the top of the window can be used to move around in the view and change its appearance. The icons will be discussed as they appear from left to right:

**Pan:** This works very much like the CAD Pan command. When you click the hand icon the cursor changes to a hand. When you click on the graphic screen the first time you are "grabbing" the graphic. You can then move it to the proper view and click a second time to "put it down". You may repeat this as many times as you wish in order to move around the drawing. When done with the Pan command, click on the Pick Point icon.

**Zoom In:** Clicking on this icon causes the graphic image to be enlarged a preset amount. The zoom factor cannot be configured. If you wish to see a certain area of the graphic image it is recommended that you click Zoom Extents then use Zoom Window to view the desired area.

**Zoom Out:** As with Zoom In, Zoom Out reduces the image size a pre set amount. The zoom factor is not configurable.

**Zoom Extents:** Zooms the image so all points and lines can be seen on the screen.

**Zoom Window:** Allows you to click on two diagonal corners of the rectangular area that you wish to see.

**Pick Point:** Use this icon to allow you to pick a point on the graphics screen in order to "zoom" to the first instance of the associated point ID found in the raw data editor window. This allows you to rapidly and conveniently locate a given point ID in the data file. This is especially useful in trouble shooting for errors or other problems in the data that may be more easily detected in the graphic image than when viewing the raw data. When you pick near a plotted point on the graphics screen its point ID is noted. The raw data file is then searched for that point ID. The active field in the editor window is then set to the first instance of that point ID. You can pick the same location several times to move to the next instance of the point ID in the file. If you have a large Pick Radius set (See Graphic Settings) or are zoomed out, picking a point may result in more than one point being found. If this occurs, a dialog box listing the nearby points will pop up. Using the list box in the dialog choose the desired point ID and press <Enter> or click OK to find the point in the data file.

Clicking this icon also allows you to turn off the Pan feature when you are done panning.

Brings up the **Graphic Settings** dialog:
The graphic settings dialog allows you to configure the appearance of the various items that may be seen on the graphics screen.

Note: The Graphic Settings dialog is also used for the SurvNET program and thus the items on the Error Ellipses and GPS tabs have no effect on the CGEditor Graphic View.

Points and Trav/SSs tabs

Control Points, Fixed Control Points and Floating Points and Traverse, Sideshots and Azimuths:
Specify whether the symbols, labels or lines for any of these should be shown. Also, if they are to be shown, specify symbol and/or line color, symbol type and point ID label size.

Symbol:
Choose to represent the various types of points as a Square, Triangle or Circle using the drop down list.

Color:
For symbol or line color you can choose Red, Green, Blue, Cyan, Magenta or Yellow from the drop down list.

Size:
Specify the point symbol size.

Pt. Num.

Text:
Check the check box if you want the points labeled.

Size:
If the points are to be labeled, specify the label height.

Pick Radius
When you pick near a point plotted on the graphics screen, the current field in the editor window moves to the first instance of that point in the current raw data file. Setting the pick radius allows you to specify how large an area around the pick point is to be searched for raw data points drawn in the Graphics View window.

Error Ellipses tab (Has no effect in CGEditor)

GPS tab (Has no effect in CGEditor)

Refresh Graphics: Allows you to refresh the graphics to view recent changes in the raw data due to editing.

Important Note: For the Refresh Graphics to reflect recent changes in the raw data file, you must save the file itself prior to refreshing the graphics.
Settings Menu

The items in the settings menu can be used to configure how the data in the raw data file will be interpreted and the appearance of that data as seen in the CGEditor.

Raw Data File Settings dialog

When you click on the Raw Data File menu item you will see a dialog box that allows you to specify many of the more important settings related to the currently open raw data files. You can also set up the defaults that will be used for newly created raw data files.

Note: See the More on Default Settings subsection at the end of the Settings Menu section.

The Raw Data File Settings dialog

Current File

To view and/or edit the settings for a given file, pick the file using the Current File list box. You can also view and/or edit the DEFAULT settings for newly created files.

File Information
This portion of the dialog allows the user to specify job or project specific information. Except for description length, these items are for your own information and do not effect processing of the raw data.

**Job:** Enter any name you wish to identify the job or project.

**Operator:** Enter the name of the person who led the field work.

**Client:** The name of the person or company for whom this work was done.

**Date:** Date in any format you wish to use.

**Temperature:** Temperature at the time the field work was done. For your reference only. May be Celsius or Fahrenheit.

**Pressure:** Atmospheric pressure at the time the field work was done. For your reference only. May be in any units.

**Book:** Field book number for the field work.

**Page:** Page number in the field book.

**Description Length:** Specify the length of the description field used in this file.

**Set Defaults:**
This button sets the items in the File Information portion of the dialog as the current default values. When a new raw data file is created, these default settings will be used. See the More on Default Settings heading at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the File Information portion of the dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the File Information portion of the dialog. These values are used as the default settings when a new file is created. See the More on Default Settings heading at the end of the Settings section.

**File Measurement Info**

**Angular Units:** Clicking the button to the right changes the angular units from Degrees to Grads or vice versa.

**Distance Units:** Clicking the button to the right changes the distance units from Foot to Meter or vice versa.

**Foot Definition:** Clicking the button to the right changes the foot definition from US feet to International feet or vice versa. This button is only active when Distance Units are set to Foot.

**Traverse Angles:** Choose one of the items in the list to specify how the traverse angles were measured:
1. Horiz. Angles
2. Azimuths
3. Deflection Angles

**Direction:**
Specify what type of angle is used to define the direction of a line. Clicking the button to the right changes the direction from Bearing to Azimuth or vice versa.

**Azimuth Direction:**
Specify the reference direction for azimuths. Clicking the button to the right changes the azimuth direction from North to South or vice versa. This button is only active when Direction is set to Azimuth.

**Coordinate Order:**
Specify the Coordinate Order from North-East to East-North or vice versa.

**Vertical Reference:**
Pick one of the items from the list to the right to specify the reference orientation for measuring vertical angles:
1. Zenith
2. Nadir
3. Horizontal

**Set Defaults:**
This button sets the items in the File Measurement Info portion of the dialog to the current default values. See the More on Default Settings heading at the end of the Settings section.
**Restore Values:**
This button allows you to set the values in the **File Measurement Info** portion of the dialog back to what they were when you opened the **Raw Data File Settings** dialog.

**Save As Default:**
Sets the default values for the **File Measurement Info** portion of the dialog. These values are used as the default settings when a new file is created. See the **More on Default Settings** heading at the end of the Settings section.

**Edit Options**

**Elevation Off:**
Check this check box to turn off the Elevation data entry column for this file. This makes data input more convenient since you do not have to enter any data in the Elevation column, nor do you have to tab through it. Turning off elevations does not cause any data to be deleted from the current file.

**Code Off:**
Check this check box to turn off the Code data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Code column. Turning off codes does not cause any data to be deleted from the current file.

**Description Off:**
Check this check box to turn off the Description data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Description column. Turning off descriptions does not cause any data to be deleted from the current file.

**Note:** You can turn the Elevation, Code and Description data entry columns on or off while editing a file by clicking on the column heading.

**Distance Component:**
Specify how distances are to be entered. Clicking the button to the right changes the Distance Component from Slope Dist-Vert Angle to Horiz. Dist-Vert. Dist. or vice versa.

**Translate Raw Descriptions Using Description Table:**
This check box is only active if descriptions are on. If you check this check box, integer codes entered in the Description field will be looked up in the specified description table (See the following item.). If a matching description number is found in the description table, the code will be moved to the Code field and the description found in the description table will be placed in the Description field. If no matching description number is found, the Description field remains as entered.

**Desc Tbl:**
Click on the Desc Tbl button use a file dialog to set or change the description table. The description table is used to set the Description field when an integer number is entered in the Description field. (See the previous item.) If you prefer, instead of clicking on the Desc Tbl button you can also type in the full file path in the edit box.

**Set Defaults:**
This button sets the items in the Edit Options portion of the dialog to the current default values. See the More on Default Settings heading at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the Edit Options portion of the dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the Edit Options portion of the dialog. These values are used as the default settings when a new file is created. See the More on Default Settings heading at the end of the Settings section.
Other Edit Options dialog

Click the Other Options button to bring up the Other Edit Options Dialog box.

![Other Edit Options Dialog](image)

**Current File:**
Click on the name of the file in the file list for which you wish to review and/or specify the settings. You can also choose to view or edit the DEFAULT settings.

**Default values for new record:**
Checking the check box for the following items causes CGEditor to "remember" the most recently entered value in the respective field. Thus when you insert or add a record containing one of the checked items, it will be filled in with a "default" value.

- **Backsight ID**
- **Horz. Angle**
- **Vert. Angle**
- **Foresight ID**
- **Rod Height**
- **Code**
- **Description**

**Note:** The previously used field values are not "remembered" and thus will not be used to fill in new records the next time you open the CGEditor.

**Set Defaults:**
This button sets the items in the Other Edit Options dialog to the current default values. See More on Default Settings at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the Other Edit Options dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the items found in the Other Edit Options dialog. These values are used as the default settings when a new file is created. See More on Default Settings at the end of the Settings section.

Click **OK** to close the Other Edit Options dialog.

Click **OK** to close the Raw Data File Settings dialog.
More on Default Settings:

When the CGEditor is started from CGSurvey, many of the initial default settings may not be those you had specified in a previous session. This is because many of the default settings you previously specified were overridden by the current CG Settings specified in CGSurvey. However, you may yourself override the default settings for the current session only by changing any of the settings and clicking the Save As Default button. If you wish to change the "default" settings for future editing sessions, you must change the CG Settings in CGSurvey.

Settings overridden by the settings on the various tabs in the CAD C&G Options dialog:

File Information: only Description Length is overridden by the settings in the CAD C&G Options dialog.
File Measurement Info: ALL items are overridden by the settings in the CAD C&G Options dialog.
Edit Options: ALL items are overridden by the settings in the CAD C&G Options dialog.
Other Edit Options: NONE are overridden by the settings in the CAD C&G Options dialog.

Record Color

To set the color for a given record type click the Record Color menu item. Then, in the Record Color dialog, click on the record type and a color selection dialog will appear. Click on the color you want the that record type to have. If you click the Set Defaults button, the original program default colors are set. Click the OK button to save the color settings and close the dialog. Click the Cancel button to close the dialog without saving the changes.
Validate Records

If this menu item is checked, all the records in the file will be validated prior to saving the file. To change the Validate Record setting, just click the menu item. If an invalid record is encountered when saving a file with the Validate Records menu item checked, you are asked if you want to edit the invalid field, ignore the error or ignore all errors. If you decide to edit the offending field, the field will be highlighted and you can edit it and attempt to save again.

The Tools menu has several items that can be used to find and replace specific text in specific types of fields. It even allows you to apply simple mathematical functions to allow you to edit the data in a group of fields in a single step.

Goto (Ctrl + T):

Select this item to go to a certain row (or record) number. In the dialog box that comes up, type in the desired row number and click OK. The editor window will zoom to that record and set the current field to the first editable field in the record.

Find (Ctrl + f) menu item:

The Find dialog allows you to enter a value to find and set the detailed search criteria.
Find: Type in the string or number you are searching for in the edit box or pick a previous search string from the list.

Field is a: Choose what type of data is in the field you are looking for. Check appropriate checkbox for matching case and/or whole word.

Columns to search:
The default is to search All columns, but if you choose the Columns radio button, you can enter a comma separated list of column numbers. The column to the right of the TYPE column is column 1 and it is the first column in which you can search.

Search:
You can search By Rows or By Columns and you can choose to search Up or Down from the current field.

Once you have specified the parameters for the search, click the Find Next button to find the first instance of the search string. Continue to click the Find Next button to find the next instance of the string. To just find the next instance of a string and close the dialog box, you can click OK.

Find Next (F3) menu item: Finds to the next occurrence of the string previously specified in the Find dialog.

Find Prev (<Shift> + <F3>) menu item: Moves you to the previous occurrence of the string previously specified in the Find dialog.

Find Record Type menu item: Allows you to find the next record type of the type specified. The search starts at the current record. When you click this menu item, the Find Record Type dialog box is displayed. Choose the record type you wish to look for by picking from the list then specify the direction of search and click the Find Next button to find the record. Click Cancel when done.

Replace (<Ctrl> + r) menu item: When you click on this menu item, the Replace dialog appears.
The Replace dialog allows you to specify a Find: value and a Replace with: value. The other fields in the Replace dialog are the same as the Find dialog. You can view the Find: value one instance at a time by clicking the Find Next button, if you decide to replace a given value found just click the Replace button. Alternatively, you can allow the software to automatically replace all the instances of the Find: value encountered in the specified columns in the raw data file by clicking the Replace All button.

Note: Before clicking the Replace All button, be sure to specify whether you wish to replace matching fields in the highlighted Selection of fields/records or in all the fields in the Whole File.

Data On/Off (<Ctrl> + d) menu item:

Selecting this menu item inserts a Data On/Off record above the current record. Records between pairs of Data On/Off records are ignored when the traverse is reduced. This can be useful when trying to find problems in a traverse.

Change

The items in this submenu allow you to change specific types of fields in the raw data file.

Point ID (<Ctrl> + I) menu item: This menu item allows you to change point IDs for instrument points, back sight points, or foresight points. You can change individual points one at a time or you can make a global change. You can specify a value to find and a value to replace it with. The Change Point ID dialog has several sections that are similar to the Replace dialog.
**Field is a:** You must specify how you want to treat the point ID field. You can do this by clicking on the **String** or **Number** radio buttons.

**Define:** You must specify whether you wish to specify the replacement value by **Value** or **Formula**.

**Note:** The **Values: (Input –> Output)** section of the dialog changes its title to **Formula:** when you elect to Define by **Formula**. Also, the content of this portion of the dialog changes according to the field type (see **Values: or Formula:** section below).

**Instr., Point, Backsight, and Foresight check boxes:** Check the check boxes of the types of point IDs you wish to change.

**Values: or Formula: section**
When Define is set to **by Value** and Field is a is specified as either a **String** or a **Number** then the title of this section of the dialog becomes **Values: (Input –> Output)** (as shown in the dialog above). In this configuration the Change Point ID dialog functions like the **Replace** dialog except that it only searches the point ID fields specified.

Specify the value to search for in the edit box to the left of the "–>" and the value to replace it with in the edit box to the right of the "–>".

The **Find Next, Replace** and **Replace All** buttons act exactly the same as the **Find Next, Replace** and **Replace All** buttons in the **Replace** dialog.

When Define is set to **Formula** the title of this section of the dialog becomes **Formula:**
If Field is a is specified as a **String**, the dialog is as shown below:

![Change Point ID dialog](image)

In this configuration the formula acts to add a prefix and/or a suffix to the existing point ID (represented by [Old]). Enter the prefix in the edit box to the left of [Old] and the suffix in the edit box to the right of [Old]. If you do not wish to add a prefix or you do not wish to add a suffix, you may leave either the left or right hand edit boxes empty.
If Field is a Number, the dialog is as shown below:

![Change Point ID dialog](image)

In this configuration the formula adds a specified number to a given point ID. Enter the positive or negative number in the edit box to the right of "[Old] +".

**NOTE:** When the Field is a Number and a point ID containing non-numeric characters is encountered, it will be skipped and no change will be made to it.

**Change Height (<Ctrl> + h)**

Use this menu item to change the instrument height and/or rod height. Clicking this menu item brings up the Change Height dialog.

![Change Height dialog](image)

**Action section of dialog**

Use this section to determine how the height is to be changed when Define is set to Formula.

**Multiply/Divide:** Choose this if you wish to multiply or divide the height by a given number.

**Add/Subtract:** Choose this if you wish to add a specified number to the height or subtract a specified number from the height.

**Define section of dialog by Value:** If you choose by Value, this command becomes like the Replace command, except that it acts only on instrument heights and/or rod heights.
**Formula:** This allows you to specify a number to apply to the height by addition, subtraction, multiplication, or division. (See the **Action** and **Values:/Formula:** sections.)

**Values:/Formula:** section of dialog  
Depending on what you choose in the Action and Define sections there are several possibilities for this section of the dialog:

When **Define** is set to **by Value** the **Action** section of dialog is disabled and the title of this section becomes **Values: (Input->Output)**  
In this configuration the feature functions like the **Replace** command, except that it acts only on instrument heights and/or rod heights.

When **Define** is set to **Formula**, the **Action** section of dialog is enabled and the title of this section becomes **Formula:**  
When the **Action** is set to **Multiply/Divide**, the **Formula:** section changes as seen below:

In this configuration you can multiply or divide the instrument height or rod height by the number specified in the edit box. To switch between multiply and divide, just click on the button with the multiply ("*") or divide ("/") symbol on it.

When **Action** is set to **Add/Subtract**, the **Formula:** section changes as seen below:

In this configuration you can add or subtract the number specified in the edit box to or from the instrument height or rod height. To switch between add and subtract, just click on the button with the add ("+") or subtract ("-")) symbol on it.
Search section of the dialog
Use this section of the dialog to specify how the records will be searched. The search begins at the currently active field.

Instrum. and Rod checkboxes: Check one or both of these check boxes to specify which types of heights are to be searched/changed.

Find Next button: Use this button to move to the next field that matches the specifications you entered.
Replace button: Use this button to replace the highlighted text that was found.
Change All button: Use this button to make the changes specified to all matching fields in the file. Be sure to specify whether to apply the changes to the highlighted Selection (records or fields) or to the Whole file.
Cancel button: Click the Cancel button to close the dialog.

Change Angle (<Ctrl> + g)
Choose this menu item to change vertical and/or horizontal angle fields. Clicking the Change Angle menu item brings up the Change Angle dialog: This dialog is almost identical to the Change Height dialog and will not be described in detail. The differences are: the Multiply/Divide action seen in the Change Height dialog is replaced by the Make Opposite action; you can check either the Vertical or Horizontal check boxes to specify the angles you wish to change; choosing Formula and Make Opposite disables the Formula: section of the dialog due to the fact that the action to be taken is merely to reverse the sign of the angle.

Change Distance (<Ctrl> + D)
The Change Distance dialog is almost identical to the Change Height dialog. The only difference is that you can choose to change the Slope distance and/or the Horizontal distance by checking the checkboxes.

Change DescLen (<Ctrl> + j)
This command allows you to set the description length for the current raw data file. It displays the Longest description length: that is found in the current records in the file. It allows you to specify a new Description length:.

Warning: If you specify a length less than the longest description found in the file, the descriptions that exceed that length will be truncated.

Network Least Sq. menu item
This menu item runs the SurvNET Network Least Squares Adjustment program. Please refer to the section on SurvNET for a detailed description of this very powerful traverse and level loop adjustment program.

Window menu
This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file.

Help

For information regarding the CGEditor program version click the About CGEditor... menu item.

Editing C&G Mapcheck Files

Mapcheck files are typically used to check the closure of a given parcel of land given the deed description of that parcel. A mapcheck file may contain straight line boundaries as well as boundaries described by both tangent and non-tangent curves.

Creating or Opening a Mapcheck File

To create a new file or open an existing file choose File on the main menu then either click New or Open. If you choose New a submenu will appear, click the C&G Mapcheck File menu item. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an existing file, click on a mapcheck file (*.cgm). Next, click the Save button for a new file or the Open button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Map Check File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing C&G Mapcheck Files.)

Mapcheck Data Entry

Opening an existing template file or creating a new one is very similar to opening or creating a raw traverse data file. There are three types of records that you may use in a mapcheck file:

Straight line (identified as Line in the Type column)
Tangent Curve (identified as TC in the Type column)
Non-tangent Curve (identified as NTC-C or NTC-R in the Type column for Chord or Radius definition NTC records)

Adding and Inserting new records
To create a new record in the current file you must either use the Add or Insert menu item or the Add or Insert toolbar.

Note: If the Add and/or Insert toolbars are not showing, click the View menu then choose the menu item for the toolbar you want to turn show.

When you click on one of the Add menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the Insert menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.
Moving from field to field: While entering data, to move to the next field, press the Enter or Tab key. To move to the preceding field press the Esc key or the Shift and Tab keys at the same time.

Straight Lines

There are two fields to be filled out in a Straight Line (or Line) record:

**Bearing or Azimuth:** For a bearing, use the standard C&G bearing notation:

**For Bearing:** Qdd.mmsss

Where

$q =$ quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)

$d =$ 2 digit bearing

$m =$ minutes

$s =$ seconds and tenths of seconds

For example: enter S 35° 22' 34.2'' E as 235.22342

**For Azimuth, use the notation:** ddd.mmsss

Distance: Enter the length of the boundary in whatever units you have specified in the Map Check File Settings.

Code: Enter a code (optional).

Note: If Code Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Code column title will turn it on.

Description: Enter a description (optional).

Note: If Description Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Description column title will turn it on.

If Translate Mapcheck Descriptions Using a Description Table is checked in the Map Check File Settings dialog and you have entered an integer number description, then when you move to the next field, the description table will be searched for a description number matching the integer entered. If a matching description number is found, the description from the table will be placed in the Description field and the integer originally entered in the Description field will be placed in the Code field.

Tangent Curves

For a Tangent Curve record there are six possible fields to enter. Of the following six fields you must enter data for two of the first four:

**Radius** - decimal distance

**Arc Length** - decimal distance

**Chord** - decimal distance

**Central Angle** - angle specified as ddd.mmsss (degrees.minutes and seconds to nearest .1 sec.)

**Code** (optional - see Straight Lines above)

**Description** (optional - see Straight Lines above)

Non-Tangent Curves

The fields in a Non-Tangent Curve record vary according to whether it is defined using the chord bearing/azimuth or radius bearing/azimuth.
When using **Non-Tangent Curve** record it is necessary to specify whether the chord or radius definition will be used when specifying the curve. There are four ways to accomplish this:

1. Prior to Inserting or Adding the record, use the **Settings** menu then choose **Map Check File**. In the **Map Check File Settings** dialog set the **Curve Definition** in the **File Measurement Info** section of the dialog.
2. Prior to Inserting or Adding the record, use the **Settings** menu to check or uncheck the **Non-Tan Curves Use Chord** menu item. When the **Non-Tan Curves Use Chord** menu item is checked, newly created **Non-Tangent Curve** records will added or inserted that use the chord definition, otherwise they will use the radius definition.
3. Prior to Inserting or Adding the record, click the **C-R** toolbar icon. When the icon appears depressed, newly created **Non-Tangent Curve** records will use the chord definition, otherwise they will use the radius definition.
4. To change the type of curve definition for an existing **Non-Tangent Curve** record, use the Edit main menu and choose the **Change Curve Def'n** menu item. This changes the current record from what it is now to the opposite type of curve definition.

For both the **Chord** and **Radius** definitions the following fields are present in the record:

**Chord or Radius Brg/Azimuth**

used to orient the curve properly as it leaves the PC. As noted in the **Tangent Curves** section, bearings must be entered in the qdd.mmsss format and azimuths entered in the ddd.mmsss format. **Radius**

**Arc Length**

**Chord**

**Central Ang**

**Code**

**Description**

All but the first field has been discussed earlier in the **Tangent Curves** section and will not be described here.

**Editing a Mapcheck File**

Most of the menu items found in the mapcheck menus have been discussed in the **Editing Traverse Raw Data Files** section. Only the differences will be discussed here.

**File Menu:** The **File** menu when editing a mapcheck file is identical to the **File** menu discussed in the **Editing Traverse Raw Data Files** section.

**Edit Menu:** With the exception of the **Change Curve Def'n** menu item, the **Edit** menu is identical to the **Edit** menu discussed in the **Editing Traverse Raw Data Files** section. **Change Curve Def'n** was discussed above in the **Non-Tangent Curves** section.

**Add Menu:** The Add menu allows you to add **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records to the end of the file.

**Insert Menu:** The Insert menu allows you to insert **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records above the current record.

**View Menu:** Allows you to turn the toolbars on and off.

**Settings Menu**

The **Settings** menu contains items that allow you to specify the format of the data in a mapcheck file and how this data will appear in the **CGEditor**.

**Map Check File settings menu item**
The **Map Check File** menu item brings up the **Map Check File Settings** dialog (see below). This dialog allows you to specify settings for each of the map check files currently open in the editor. It also allows you to specify the default settings for creating new map check files.

**Current File:** Use this list to choose a file you wish to set or view the settings for. You may also set or view the DEFAULT settings that are used for newly created files.

**File Information and Edit Options:**
The settings in the File Information and Edit Options sections have been discussed under the Settings Menu section of Editing a Raw Data File.

**File Measurement Info:**
Most of the settings in the File Measurement Info section have been discussed under the Settings Menu section of Editing a Raw Data File. However, a **Curve Definition** item has been added to this section for map check files:

- **Curve Definition:** click the **Curve Definition** button to change from Chord to Radius definitions and vice versa. **Curve Definition** only applies to the insertion or addition of Non-Tangent Curve records.

**Record Color menu item**

The **Record Color** menu item has been discussed under the Settings Menu section of Editing Traverse Raw Data Files. The only difference is that here you are setting the colors for the various types of map check records instead of raw data records.

**Validate Records**

This menu item allows you to set whether records are validated prior to being saved. (See also, Validate Records in the Settings Menu section of Editing Traverse Raw Data Files.)

**Non-Tan Curves Use Chord:** Use this to switch which types of Non-Tangent Curve records are added or inserted.
Tools, Window and Help Menus the items in these menus have been discussed in the Editing Traverse Raw Data Files section

C&G Cross Section Files

Cross section files contain data which defines one or more topographic or design cross sections along an alignment. Any features using a cross section file assume that it is at right angles to the alignment. Each cross section is identified by its station along the alignment. Each cross section is defined by a Station record specifying a station on the alignment followed by a series of Point records specifying the offset and elevation of points on the cross section at that station. Cross sections can be used to visualize a site, specify design elevations and calculate volumes. Opening an existing cross section file or creating a new one is very similar to opening or creating a map check file.

Cross Section File Data Entry

Station Records: There are three fields to be filled out in a Station record:
Station: Specifies the station of this cross section along the alignment. For example: station 6+45.37 is indicated as 645.37.
Left Slope: This field defines the slope at the left side of the cross section in feet per foot (or meters per meter if units are set to meters). This slope will be used to extend this cross section to meet any cross section it overlays.
Right Slope: This field defines the slope at the right side of the cross section in feet/foot (meters/meter). This slope will be used to extend this cross section to meet any cross section it overlays.

Point Records

There are two fields in a Point record:
Offset: The Offset defines the perpendicular distance from the alignment to this point on the cross section.
Elevation: The Elevation specifies the elevation of this point on the cross section.

Cross Section File Data Editing

Adding and Inserting new records: To create a new record in the current file you must either use the Add or Insert menu or toolbars.

Note: If the toolbars are not showing, click on the View menu then click the item for the toolbar you want to turn on.

Settings Menu item

Record Color:
The Record Color menu item has been discussed under the Settings Menu section of Editing Traverse Raw Data Files. The only difference is that here you are setting the colors for the various types of cross section records instead of raw data records.

Validate Records: This menu item has been described in the Settings Menu section of Editing Traverse Raw Data Files

US Foot: If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled.
International foot: If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled.

Feet: If this menu item is checked units are Feet.

Meters: If this menu item is checked units are meters.

Note: The settings for US Foot and International foot will be ignored if Meters is checked.

C&G Template Files

Template files contain data defining standard cross section templates that can be used to create a cross section file that represents the design cross sections for a proposed alignment. Cross section files created using templates can be overlaid on existing cross sections to allow the computation of cut and fill volumes and to visualize the design alignment. Opening an existing template file or creating a new one is very similar to opening or creating a map check file.

Entering and Editing Template Data

Entering and editing template data is analogous to that described in Entering and Editing Cross Section Data except that, instead of being identified by their station along the alignment, templates are identified by an integer template identifier. This identifier is used when building a cross section from templates in order to specify a template among the many that a template file may contain. Templates are placed along a proposed alignment at various stations and thus create a series of cross sections using the alignment elevation to set the elevation of the template points. When building cross sections along an alignment using templates, cross sections at stations between two template stations result in a series of cross sections being created to transition between the templates.

Template File Data Entry

Template Records: There are five fields to be filled out in a Template record:

Template: Template number for identifying the template

Left Slope: Specifies the slope at the left side of the template in feet/foot (meters/meter). This slope will be used to extend this template generated cross section to meet any cross section it overlays.

Right Slope: Enter the slope at the right side of the template in feet per foot (or meters per meter units are set to meters). This slope will be used to extend this template generated cross section to meet any cross section it overlays.

Offset: The Offset defines the distance from the centerline of the template to this point on the cross section. The template centerline should be assigned a 0.0 offset. The 0.0 offset is placed on the alignment when cross sections are generated from templates.

Elevation: The Elevation specifies the elevation of this point on the template. If the elevation of the centerline point is set to 0.0, then this elevation can be used to directly compute the elevation of the point based on the elevation of the alignment where the template is placed.

Editing a Template File: All template menu items and editing procedures are identical to those described for cross sections.

Editing Coordinate Files

Coordinate files contain data on the Point IDs, Northing, Easting, Elevations, Descriptions and, for C&G files, Codes for various points located in the field and points created by calculations and/or by hand data entry. The coordinate file may have points from a single job, portions of a single job or many jobs. The Point ID must be a
unique identifier for a given point. Typically Point IDs are integer numbers but may also be any combination of letters and numbers depending on the format of the file.

The CGEditor can be used to edit six different types of coordinate files. All the supported coordinate file types have **Point ID**, **Northing**, **Easting**, **Elevation**, and **Description** fields. In all formats, any given point may have a blank **Description** field. The types of files supported and a brief description of their differences follows:

**C&G Numeric (*.crd)**
*Point ID*: any integer number between 1 and 65,536.
*Description*: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
*Code*: up to 4 characters long. Used to filter and sort points. The **Code** field may be blank.

**C&G Alpha-numeric (*.cgc)**
*Point ID*: up to 10 characters long and can contain any combination of alphabetic and numeric characters.
*Description*: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
*Code*: up to 4 characters long. Used to filter and sort points. The **Code** field may be blank.

**Carlson Numeric (*.crd)**
*Point ID*: any positive integer number containing 1 to 9 digits.
*Description*: entries can be from 0 to 31 characters long.
*(the **Code** field is not supported.)*

**Carlson Alpha-numeric (*.crd)**
*Point ID*: any a series of from 1 to 9 alphabetic or numeric characters.
*Description*: entries can be from 0 to 31 characters long.
*(the **Code** field is not supported.)*

**Simplicity (*.zak)**
*Point ID*: can be any positive integer number containing 1 to 8 digits.
*Description*: entries can be from 0 to 28 characters long.
*(the **Code** field is not supported.)*

**Land Desktop (*.mdb)**
*Point ID*: can be a series of from 1 to 255 alphabetic or numeric characters.
*Description*: entries can be from 0 to 255 characters long.
*(the **Code** field is not supported.)*

**Creating or Opening a Coordinate File**

To create a new file or open an existing file choose **File** on the main menu then either click **New** or **Open**. If you choose **New** a submenu will appear, click the **Coordinate File** menu item or click on the "C" icon in the **Standard** toolbar. Next pick the type of coordinate file you wish to create using the **Coordinate File Type** dialog:
A new coordinate file with a temporary name will appear in its own document window in the CGEditor and will contain only a single blank coordinate Point record.

If you are opening an existing file using the Open menu item, you will be asked to choose the file using file dialog. Browse to the directory where you wish to work click on a coordinate file and click the Open button. The coordinate records from the file will appear in a separate document window in the CGEditor.

It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Coordinate File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing Coordinate Files.)

Entering and Editing Coordinate File Data

Once a coordinate file has been opened or created, you can edit any of the fields in any of the records. To create a new coordinate point you must use the Add/Insert main menu or toolbar. Both the Add/Insert menu and toolbar allow you to add or insert individual blank records or one or more records from an existing coordinate file. When you add a record or records, they are appended to the end of the file. When you Insert one or more records they are inserted just above the current record.

Insert and Adding Coordinate Records from an Existing Coordinate File

If you choose to either the Add or Insert Pts from File or the corresponding toolbar item, you will see the C&G Select Points from: dialog.
This dialog consists of a list of the points chosen so far from the file listed in the Change File to Select From edit box. Use the File button to set the file name and the Open button to open the file for use. When the dialog first comes the point list is empty.

**Choose Points section**

Choose one of the available methods you will use for choosing points. Different methods will cause data entry controls to appear below the Choose Points section.

Note: Any time there are points in the list the REMOVE from SELECTION button will be enabled. Clicking this button will remove points from the list according to the current method being used to choose points.

**All**

If you choose all and not all of the points in the file are in the list, the ADD from FILE button will be enabled. Clicking the ADD from FILE button will add all the points from the file to the list.

**Block**

If you choose the Block method, the following Define Block section will appear below the Choose Points section of the dialog.

```
Define Block
Start Point ID
End Point ID

Compare like:
- Numbers
- Strings
```

Fill in the Starting Point ID and End Point ID then click the ADD from FILE button.

**by Desc**

If you choose the by Desc method, the following Specify Description section will appear below the Choose Points section of the dialog.
Fill in the description to look for and check the Match Case and Match Whole Work Only checkboxes as needed. Next click the ADD from FILE button

and any matching point records will be added to the list.

by Code

If you choose the by Desc method, the following Specify Code section will appear below the Choose Points section of the dialog. This section of the dialog looks and functions the same as the Specify Description section shown above except you must specify a code.

by Elev

If you choose the by Desc method, the following Specify Elevation section will appear below the Choose Points section of the dialog.

Specify the high and low elevation values. You can do this by directly entering the elevation values or you can type a point ID in the Point ID edit box then click on another edit box. When you do this the elevation of the point is written to the appropriate Elevation edit box. If you used a point ID to get the elevation, you can edit the value if necessary. Next click the ADD from FILE button to add the points to the list.

in Radius
in Rect

Coordinate File Data Entry

There is only one type of coordinate record called a Point record. This record has six fields:
Point ID: Point identifier must be unique. Its format varies according to the type of coordinate file.
Northing: Specifies the northing or Y coordinate of a point.
Easting: Specifies the easting or X coordinate of a point.
Elev: Specifies the elevation or Z coordinate of a point. (May be On or Off. To turn the column on click the column heading.)
Code (C&G coordinate files only):
a 4 character optional field used to group points. May be blank. (May be On or Off. To turn the column on click the column heading.)
**Description:**
Text describing the point. May be blank. Length limited by type of coordinate file. (May be On or Off. To turn the column on click the column heading.)

After adding or inserting a **Point** record, fill in the various fields as needed. Use the Tab or Enter keys to move from one field to the next. If you press Enter when in the last activated field in a record, a new blank record will be created just below the current record and the current field will be set to the **Point ID** field in the new record.

To replace the data in an existing record, just click once on the field you wish to replace and begin typing the new data. To edit the data in an existing record, click twice on the field you wish to edit and make any edits required in the existing data.

**Settings Menu**

**Coordinate Files**

Choosing this menu item brings up the Coordinate File Settings dialog.

![Coordinate File Settings Dialog](image)

**Settings for**
drop down list box allows you to specify settings for any coordinate file currently open in the **CGEditor** as well as choose to set the **Default settings for new files you create.**

**Type of File** is only visible for the files currently open.

**Description Length:**
this edit box can be used to set a new description length for the file. If you choose to change the description length, any descriptions that already exist in the file will be truncated to the new length.

**Translate Coordinate Descriptions Using Description Table** checkbox
if this is checked then the description table file name edit box and the **Browse...** button will be enabled and you will be required to specify a description table to use.
Description ON checkbox - if this is checked then the Description column will be activated in the editor.

Point Code ON checkbox - if this is checked then the Code column will be activated in the editor. (Only applies to C&G coordinate files)

Elevation ON checkbox - if this is checked then the Elevation column will be activated in the editor.

Units: click the button to switch between Foot and Meter.

Foot Definition: click the button to switch between US and International feet. (Disabled if Units are set to Meter)

Coordinate Display section
Places displayed: drop down list - use to specify the number of decimal places displayed in the editor for northing, easting and elevation.
Note: the Places displayed setting does not effect the values actually stored in the coordinate file, only how they are displayed in the editor window.
Coordinate Order: click button to switch between North-East and East-North.

Printing: Page Orientation section
choose Portrait or Landscape. You may wish to choose Landscape to avoid having the coordinate records with long descriptions causing each page to span 2 pages in width.

The Set Defaults, Restore Values and Save As Default have been covered elsewhere.

US Foot menu item
If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

International foot menu item
If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Feet menu item: If this menu item is checked units are Feet. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Meters menu item: If this menu item is checked units are meters. The check will also be set or cleared by changes in the Coordinate File Settings dialog. Note: The settings for US Foot and International foot will be ignored if Meters is checked.

Tools Menu
With the exception of Renumber Points, the items on the Tools menu are similar to those items already discribed for other file types.

Reumber Points menu item
When you choose the Renumber Points menu item you will receive a warning regarding the problems that
may be encountered in existing C&G drawings.

![Screenshot of CGEditor - Warning]

After considering the problems you may encounter due to point renumbering respond Yes or Yes-Don't Ask Again to continue with the renumbering operation, or No to cancel the operation.

If you choose to continue with the renumbering of points, you will see the Renumber Points dialog:

![Renumber Points dialog]

**Renumber Points dialog**

**Points to Renumber section**
First choose All or Enter Points.
If you choose Enter Points you must fill in the edit box specifying the points to renumber. The points to renumber can consist of single points or range(s) of points. Multiple entries of ranges and/or single points must be separated from the next entry by a comma (",") and ranges must be specified using a dash ("-")

**Renumbering Method section**
choose Add or Multiply then enter the Amount to Add: or Multiply by: in the edit box. You may specify a positive or negative whole number.

When done click OK. Click Cancel to end the command without changes to the coordinate file being edited.

**Editing C&G Point Group Files**

A C&G point group is essentially a list of points placed in a specially formatted text file (*.pts). It is possible to create and/or edit point group files using any plain text editor like Microsoft Notepad or Wordpad if you know the format of the file. Typically it is far easier to use the CGEditor to create and/or edit C&G point group files. Point groups have many uses in C&G commands: road alignments, property boundaries, define Include and Exclude Boundaries for Topo commands, etc. In the case of alignments, a point group can also include vertical curve information.

C&G point group files are organized into named subgroups. The subgroup name can be anything you wish.
to use to identify the points that follow. You may have several subgroups in a single point group file. For example, if you are defining subdivision lots, then you may choose the subgroup names to be lot 1, lot 2, etc. For an alignment you can make the subgroup name the starting station and C&G features will make this the default starting station when asking you for an alignment. Point groups can also be used to.

Creating and Opening Point Group Files

You may open and/or create as many files as are needed for your project.

To create a new empty point group file choose the File menu then the New menu item then the Point Group File menu item or, more simply, just click the "P" toolbar icon on the Standard toolbar. In either case, a document window will appear within the main CGEditor window. This will have a single blank record or row for the Subgroup name - identified by SGR in the Type column.

To open an existing point group file, choose File then Open... Then, in the file dialog, browse to the directory where your point group file is located, highlight the desired file and click the Open button. The records will be read from the file and will be displayed in a separate document window

Entering and Editing Point Group File Data

If you do not have a subgroup name record, choose the Add/Insert main menu then, if you wish to place it at the end of the file, choose the Add Subgroup menu item or, if you wish to insert it above the current record, choose the Insert Subgroup menu item. After filling in the subgroup name, you can just press Enter to add a single Point record (identified by PNT in the Type column) below the subgroup name record. Alternatively, you can use the Add/Insert menu to add or insert a single point or you can choose to add or insert several points from a coordinate file. These same add and insert methods can be found on the Add/Insert Toolbar.

If you choose to Add or Insert Pts from File the following dialog comes up:

The use of this dialog to choose points has been described in detail under the section on Editing Coordinate Files. Please refer to that section for more details. After choosing the points you wish to add or insert into the point group using the C&G Select Points from ... dialog, click OK and the point records will be created in the point group file being edited.
**Horizontal Curves**
You may have noticed that the *Rad Pt Type* column is marked with `<None>` for the points you have inserted so far. However, if you wish to specify a curve in your alignment or lot boundary, you must designate the record as a radius point. If you click on the *Cw* toolbar icon (for clockwise) or the *Cc* toolbar icon (for counter clockwise) or choose similar items on the *Tools* menu, you will notice that the *Rad Pt Type* column for the point changes to *CW* or *CCW* to indicate that the point is a radius point. If a radius point is specified, the preceding point is assumed to be the PC and the following point is assumed to be the PT. If you wish to change the point back to not being a radius point, click the *Not Radius Pt* toolbar icon or use the *Tools* menu.

**Vertical Curves**
You may enter vertical curve information in a point group file. This allows you to not only specify the horizontal location of the alignment, but also its vertical alignment. A point group file that has vertical curves in it may not contain any subgroup records. If you attempt to place vertical curve data in a file having one or more subgroups, you will be given the following warning:

As indicated by the choices in the dialog, you may continue and place vertical curve info in a point group file containing subgroups, but it will not be usable in C&G commands.

If you have no subgroups (or if you do and answer "Yes" to the warning) and this is the first vertical curve in the file, the *Enter Vertical Curve Information* dialog will come up.

![Enter Vertical Curve Information dialog](image)

Enter the information in the dialog to specify the vertical curve. The *Starting Station* and the *PVI Station* should be entered as decimal numbers and when you click in another edit box the decimal station will be converted to standard station notation. The *Slope in* and the *Slope out* should be entered as a percent (For example, enter 2 or 2.0 for 2%). When you click *OK* the vertical curve records *VC1* and *VC* are added in the document window.

For the second and succeeding vertical curves, you can either *Add Vertical Curves* to the end of the vertical curve records or you can *Insert Vertical Curves* within the existing vertical curve records. For these vertical curve records, the dialog requires fewer entries:
This is a result of the fact that the initial vertical curve Starting Station, Initial PVI Elevation and Slope in control the overall vertical orientation of the succeeding vertical curves thus you need only enter the PVI Station, Length and Slope out for these vertical curves. When you click OK, another vertical curve record will be added to or inserted into the document.

Once the vertical curve information has been specified you can go ahead and enter the points specifying the alignment.

**Settings Menu**

The Settings menu allows you to configure the point group file and the record appearance.

Choose the Point Group Settings menu item to bring up the Point Group Settings dialog:

![Point Group Settings dialog](image)

In this dialog you can set the units and the page orientation for printing.

**Note:** the units setting only effects the display of stations in station notation.

Choose the Record Color menu item to bring up the Record Color dialog. Set the display color of the various records by clicking on the line for the record type. This brings up a color dialog that allows you to pick from the 16 available colors. Click OK when done.

**Tools Menu**

The items in the Tools menu are, for the most part, self explanatory or have been covered in detail for other types of
files.

**Pulldown Menu Location:** CG-Survey>Tools>CGEditor

**Keyboard Command:** eda, cg_edit_all

**Prerequisite:** May need existing C&G raw traverse data file (*.cgr), C&G Map Check file (*.cgm), C&G Cross Section file (*.cew), C&G Template file (*.ctp), coordinate files (*.crd, *.cgc, *.zak, *.mdb) and/or C&G Point Group files (*.pts)
Construction Module 5
Overview

The Construction module is a combination of the Survey, Civil and Takeoff modules. The Construction tools cover surface modeling, earthworks, roads, machine control data prep, survey as-built mapping and stakeout. All of the commands for Construction are described in other parts of the manual under the Survey, Civil and Takeoff chapters.
Civil Module
3D Data Menu

Change Elevations

This command will change the elevation of selected entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson points are selected, their elevation attribute text and the elevation stored in the external coordinate file are changed. If the points are in the drawing at their real Z, this is also adjusted, however, if they are in the drawing at a fixed elevation, e.g. 0, the point blocks remain at that elevation.

There are options to move the changed objects to a new layer, and alternately to select a source object's elevation to supply the value of the elevation to change the selected object(s) to.

Prompts

Type of elevation change [<Absolute>/Differential]: press A to change to a specific (absolute) value, or press D to enter an amount of elevation change to apply to object's current elevation.

Change Layer for changed entities [Yes/No]: press Enter or N to keep on same layer, press Y to change layer of object after changing elevation.

Select/<Enter Elevation >: 125 By using the Absolute option all entities selected are changed to the elevation 125. You may simply press Enter to keep the value shown in brackets. Press S to select a source object's elevation for the new elevation to change the selected object(s) to.

Select objects: 1 found

Tested 1 Entities
Carlson Software Points Changed> 1
Select/<Input another Elevation (Enter to end)>: press Enter

Pulldown Menu Location: 3D Data
Keyboard Command: chgelev
Prerequisite: Something to change

Set Polyline To Elevation

This command allows you to assign elevations to one or more polylines. The command also affects lines, arcs, circles, inserts and points as well as polylines. The elevation can be assigned by entering the value or by picking an existing object or text entity that has the desired elevation. Note that this will change 3D objects to a single target elevation (making it a 2D object) as well as changing elevation values of 2D objects.

Note that this is the same command as 3D Entity to 2D on the Edit menu.

Prompts

Enter/<Select text or linework of elevation>: Press E to enter a value directly, or select text or linework of source value

Linework Elevation: 440.000 (elevation of selected linework displays).

Select Lines, Arcs, Circles, Polylines, Inserts and Points for elevation change.
Select objects: 1 found
Select objects: 1 found, 2 total
Select objects: 1 found, 3 total
Select objects: press Enter to conclude selection.
LWPOLYLINE (indicates entity type)

LWPOLYLINE

3D POLY to 2D POLYLINE

Number of entities changed > 3

Pulldown Menu Location: 3D Data
Keyboard Command: 3dto2d
Prerequisite: A polyline and a target elevation to assign

Edit-Assgn Polyline Elevations

This command allows very precise control of 3D polylines, specifically in the ability to edit vertex elevations, as well as add, delete, or move vertices. You can also control the location of polyline vertices as defined by the station and offset of the vertices relative to a Centerline.

Polyline vertices are designated as either Control or Free vertices. The elevation of Control vertices are set and held, the elevations of Free vertices are interpolated. In the drawing, control vertices are shown with red boxes, along with their vertex number and elevation. Free vertices are displayed with blue boxes and are not annotated.

When you run the command, you are first prompted to select a polyline to edit. When you pick a polyline to work with, the following control panel appears on the left side of your screen.
The top row of buttons across the top of the control panel are used to manipulate the view in the drawing with various Zooming and Panning options. (The wheel mouse may also be used). The second row of buttons will change as you select different tabs, but are essentially used to add vertices, delete vertices, or pick elevations or locations for vertices.

The four tabs in the panel provide access to control of polyline vertex Elevation, Position, Offset and Settings.

**Elevation:** This tab displays the vertices of the polyline, each with a check box to set whether it is a control vertex or free, its assigned number, its elevation, and the slope from the previous vertex to that vertex. Selecting a vertex highlights its grip in the drawing. Once selected, you can enter an elevation or slope for that vertex in the spaces below the list, thereby automatically setting the vertex to a control vertex. The Base Elevation is used to adjust the elevations of all the vertices simultaneously.

**Position:** The Position tab displays the coordinates of each vertex. To move a vertex, you can type in new coordinates, use the Pick Position icon to specify a new location for the vertex on the screen, or you can grip the vertex and drag it to a new location.

**Offset:** The Offset tab requires the selection of a Centerline to reference. Once a Centerline is designated, the Station and Offset of each vertex relative to the Centerline is displayed and can be edited.

**Settings:** The Settings tab provides control over various overall options pertaining to the use of the command.

**Right-click menu:** There is a right-click menu available at all times which also gives access to a variety of functions and settings.

**Pulldown Menu Location:** 3D Data
**Keyboard Command:** edit_pline_z
**Prerequisite:** 3D Polylines with vertices
Edit-Assign Wall Polyline Profiles

This command creates a retaining wall object using a polyline to define the alignment and attaching top and bottom profiles. This polyline is recognized by surface modeling commands like Triangulate and Contour as a retaining wall and the top and bottom profiles get built into the model.

The polyline should be drawn so that the left side is the low side and the right side is high. Use the Reverse Polyline command in the Edit>Polyline Utilities menu if you need to switch the polyline direction.

The command prompts to select the polyline for the wall. If the polyline isn't already set as a wall polyline, the program prompts for a reference surface file which is used to define the initial top and bottom wall profiles. When the polyline is already set as a wall, the program loads the wall definition and goes directly to the profile editor.

The profile editor has a toggle to switch between editing the top and bottom profiles. Please see the Input-Edit Road Profile command for a description on how to use the editor.

Prompts

Pick retaining wall polyline: select polyline for wall
Profile Editor dialog

Pulldown Menu Location: 3D Data
Keyboard Command: rwallpro
Prerequisite: polyline and surface file
This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with the surface definition contained in the selected grid (.grd) or triangulation (.flt, .tin) surface file. The command then interpolates elevations from these intersections at the original vertex locations. An application for this command is to "drape" linear features along a surface such as a 2D centerline. For example, a 2D centerline may be created in the drawing and then elevated to the target surface, thus providing a quick "profile" of the centerline which can then be offset for left and right edges, constructing a 3 dimensional model of the corridor alignment.

When you first run the command, a dialog pops up for selecting the desired surface file to use. Once selected, the following prompts appear:

Prompts

Loading edges...
Loaded 8788 points and 26097 edges
Created 17310 triangles

Select polylines to convert. select one or more 2D polylines
Select objects: 1 found
Select objects: press Enter to conclude selection.

Use current polyline elevations as vertical offset from surface [Yes/<No>]? press Enter to accept default.
Keep existing polylines [Yes/<No>]?
Set layer name for converted polylines [Yes/<No>]? Press Y to assign a new layer name or press Enter
Converting polylines ...
Elevated 1 polylines.

Pull-down Menu Location: 3D Data > 2D to 3D Polyline
Keyboard Command: 2dto3dpf
Prerequisite: polylines and a grid file or triangulation file.

2D to 3D Polyline by Screen Entities

This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with surface entities (contour polylines, triangulation lines) and by interpolating elevations from these intersections at the original vertices locations. An application for this command is to create breaklines. For example, a ridge or valley breakline could be generated from contour lines by drawing a 2D polyline along the ridge top or valley bottom, crossing the contours. Then the command would "grab" the contour line elevations along the polyline to make a ridge or valley breakline.

Prompts

Select polylines to convert. select polylines
Select objects: 1 found
Select objects: press Enter to conclude selection.
Intersection extend tolerance <0.1>: enter value for "near" intersections that so not quite intersect.
Select surface 3DFaces, lines and polylines. select source 3D objects
Select objects: Specify opposite corner: 7 found
Select objects: press Enter
Reading points ... 5353
Keep existing polylines [Yes/<No>]? press Enter to accept defaults in brackets
Set layer name for converted polylines [Yes/<No>]?
Converted 1 polylines from 24 intersections.

Pulldown Menu Location: 3D Data > 2D to 3D Polyline
Keyboard Command: 2dto3dps
Prerequisite: Polylines and 3D surface entities

2D to 3D Polyline by Points
This command converts a 2D polyline into a 3D polyline by using the elevations of points. At each vertex of the polylines, the program looks for a point with elevation at the same x,y location. The points can be Carlson point blocks or POINT entities. This routine can be useful if the linework is created in 2D at zero elevation with commands like Design Polyline, and points with elevation are located along the linework. Then the linework can be converted into 3D polylines with this command. For example, a centerline polyline with arcs may need to be created in 2D for stationing because AutoCAD does not allow arcs on 3D polylines. To use this polyline as a breakline in surface modeling, this command can convert the polyline into a 3D polyline.

Prompts
Enter the maximum offset tolerance <0.1>: press Enter
Select polylines to convert, select polyline(s)
Select objects: 1 found
Select objects: press Enter to conclude selection
Keep existing polylines [Yes/<No>]?: Y
Layer name for 3D polylines <BREAKLINE>: press Enter
Select points from screen or by point number [<Screen>/<Number>]?: press Enter
Select points: (select by window)
Specify opposite corner: 1647 found
Select points: press Enter to conclude
Converting ...
Found 549 points on polylines.
Changed 1 polylines.
The routine will convert the 2D polyline into a 3D polyline and place it on the indicated layer.

Pulldown Menu Location: 3D Data > 2D to 3D Polyline
Keyboard Command: 2dto3dpt
Prerequisite: A polyline and points

2D to 3D Polyline by Text
This command allows you to change 2D polylines to 3D polylines by elevation labels.
This command will prompt you for samples of the elevation labels and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the polylines with their labels you want to convert.

You will then be prompted to enter in an elevation to add to label values. Often, elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 539.97, 540.02, 540.11 sometimes, like in the example below, they are listed as 39.97, 40.02, 40.11. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing.

This command will assign elevations from the labels to nearby vertices. If vertices do not have a nearby elevation label, then they will be interpolated from vertices that do have nearby elevation labels.

Prompts

Select sample of elevation text: pick a text label
Select sample of a polyline to convert: pick a polyline
Select polylines to convert and elevation labels.
Select objects: select all the entities to process
19 found, 19 total
Enter elevation to add to label values <0.00>: 500
Pre-processing entity #19 of 19
Processing elevation text #18
Remaking polyline #1

Pulldown Menu Location: 3D Data > 2D to 3D Polyline
Keyboard Command: elevfb
Prerequisite: 2D polyline and elevation labels

2D to 3D Polyline by Text With Leader

This command will assign elevations from the labels to the polylines by following the label leaders to their corresponding vertices on the polyline.
The command will prompt you for samples of the elevation labels, the leaders, and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the labels and leaders for the polylines you want to convert. Since you pre-specified the layers involved, you may safely window everything or type the keyword ALL and only those layers specified will be examined. You will then be prompted to enter an elevation to add to label values. Often, elevations are abbreviated to save time and space. For example, if every elevation in the drawing is in the 800s instead of labeling every elevation 817.85, 817.40, 817.30 sometimes, like in the above example, they are listed as 17.85, 17.40, 17.30 This option allows you to add a given amount, such as 800, to every label elevation to produce the correct elevation in the drawing.

The program searches for all leaders and gathers their associated text. If the program finds different labels in the elevation text, then this dialog box allows you to select the text you want to use to create the 3D polylines. In this example you might want to use elevations followed by TC. This dialog box allows you to select that text and exclude the other text which is not to be used in the elevations of the polyline, such as FS.

If you are creating 3D polylines from multiple elevation labels, then this dialog box will allow to offset certain labels by a given amount. In the above example you can offset an elevation labeled TC by -0.50 so that it matches vertices set by FS labeled elevations. **Note:** you must press Enter after setting the offset amount to assign it to the selected prefix in the list above.
Prompts

**Options/Select sample of elevation text:** pick a text label (Press O to set tolerance options).

**Select sample of an annotation leader:** pick an annotation leader

**Select sample of a polyline to convert:** pick a polyline

**Select polylines to convert, leaders and elevation labels to process.**

**Select objects:** select the desired entities This will filter by only those layers identified in above steps.

**Joining adjacent polylines...**

**Reading the selection set ...**

Enter elevation to add to label values \( <0.00> \): \( 800 \)

**Pre-processing entity #19 of 19**

**Filtering text entities**

Conflict detected: pick polyline corresponding to current leader

Press N for next selection, A for all objects, or Enter to accept current object only: press Enter

**Processing leader #6**

**Remaking polyline #1**

---

**Pulldown Menu Location:** 3D Data >> 2D to 3D Polyline

**Keyboard Command:** elevfl

**Prerequisite:** 2D polyline, elevation labels, and leaders

---

**2D to 3D Polyline by Start/End Elevations**

This command allows you to convert a 2D polyline to a 3D polyline by specifying the starting and ending elevations of the polyline. All intermediate polyline vertices elevations are linearly interpolated from these end point elevations.

**Prompts**

**Select polyline to assign elevations:**

Enter starting elevation: \( 109.85 \)

Percent/Ratio/<Enter ending elevation >: \( 112.16 \)

Select polyline to assign elevations (Enter to End): press Enter

---

**Pulldown Menu Location:** 3D Data > 2d to 3D Polyline

**Keyboard Command:** 2dto3dpl

**Prerequisite:** A polyline

---

**Assign Contour Elevations: Multiple in Series**

This command can be used to quickly and accurately assign the elevation of series of polylines that have been converted from raster or digitized without correct elevations. The routine will automatically assign elevations to the polylines crossing the fence line selected by two points. At the same time the elevations are changed, the program can assign it a new layer, color, linetype, and polyline width. This process usually works best if contours are in a temporary (white) layer to start. When they are processed, they will take on the color of the new layers making it easy to distinguish which polylines have been processed.
Assign Contour Elevations: From Contour Labels

This command allows you to set elevations to contours from elevation labels.
Select a sample of the elevation text to be used on the contouring. Next, select a sample of the contouring that you want to add the elevations to. Now select all the contours and their corresponding elevation labels and press Enter. Carlson Civil will then add elevations to all the contours. You may be prompted to distinguish what contour goes with what elevation label. You can either press Enter to accept the contour that Carlson Civil has selected or you can Press N to choose another contour.

Prompts

Select sample of elevation text: pick an example text elevation
Select sample of a contour line: pick an example contour polyline
Select contour lines and elevation text to process.
Select objects: select the entities to process
Joining adjacent polylines...
Reading the selection set ...
Joining ...
Pre-processing entity #1008 of 1008
Filtering text entities
Processing elevation text #518
Conflict detected: pick contour corresponding to current elevation text
Press N for next selection or Enter to accept current:
Remaking polyline #311

Pulldown Menu Location: 3D Data > Assign Contour Elevations
Keyboard Command: txtcelev
Prerequisite: Contours and contours labels

Assign Contour Elevations: Single Elevation Group

This command changes the elevations of polylines and can be used to set the elevations of contour polylines. The routine begins at a specified elevation and prompts for a selection set of polylines to set to the elevation. Then the routine repeats using the last elevation plus the elevation increment. Enter an empty selection set to exit the routine.

Prompts

Starting elevation <0.0>: 500.0
Contour interval (negative for down) <1.0>: 5.0
Select polylines to set to elevation 500.0.
Select objects: pick the polylines
Select polylines to set to elevation 505.0.
Select objects: pick the polylines
Select polylines to set to elevation 510.0.
Select objects: press Enter

Pulldown Menu Location: 3D Data > Assign Contour Elevations
**3D Entity By Surface Model**

This command assigns the elevations of the selected points, inserts, lines and polylines to the elevations defined by the specified grid (.GRD) or triangulation (.FLT, .TIN) file. For lines and polylines, additional vertices are added to model the surface. 3D Polylines cannot have arcs, so any arcs in the original 2D polylines are converted to a series of chords. This command is useful to "drape" objects onto a surface and to easily update them if they are moved to a different location on the surface later by executing the command again.

**Prompts**

Choose Grid or Tmesh File to Process dialog
Select points, inserts, lines and polylines to convert.
Select objects: pick the entities to convert
Converting entities ...
Done.

**Pulldown Menu Location:** 3D Data

**Keyboard Command:** convert3d

**Prerequisite:** entities to be converted, grid or triangulation file

**Pad Polyline By Interior Text**

This command allows you to set one or more pad elevations using interior text labels.

In the Pad Polyline Options dialog box, you can choose whether to have the new geometry created on a new layer, and if so, specify the name for the layer. You also specify whether to trim any elevated polylines crossing through the new elevated pad. You also specify whether to horizontally offset the new polyline from the original geometry, and if so, whether to offset to the inside, outside, or both, and by how much.

The Snap Tolerance field joins linework which falls within the range you set to create a pad.

Elevation to add to text values adds to the values from the elevation labels. Often, elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing.
After completing the dialog box, click OK. You are prompted to select the layers you want to use for the text representing pad elevations and for the boundaries of the pads. You do this to tell the routine which layers to process once you are prompted to select objects to convert. Also, sometimes pads are drawn with linework from two different layers and Carlson Civil allows you to pick all the linework layers. If you chose to Trim Elevated Polylines Inside Pad, you are also prompted to identify by selection the layer(s) with the elevated polylines that you want trimmed. Finally, select all the pads, labels, and existing elevated polylines, press Enter, and the new polylines with elevations will be created.

Prompts

Select layer sample of elevation text: pick a label text
Selected text layer —-TX07
Select layer sample of boundary linework: pick a pad polyline
Selected linework layer PAD
Select another layer sample of boundary linework (Enter to continue):
Select text and linework to process.
Select objects: select pad and text entities
Analyzing entire selection...
Set elevation for 1 polylines.
Pulldown Menu Location: 3D Data
Keyboard Command: pad_by_text
Prerequisite: Pad polylines and elevations

Draw Building Envelope Polyline
This command creates a rectangular polyline around selected linework. This can be used to give a building all one elevation.

In the Draw Building Envelope dialog box, set the layer for the new polyline and the desired offset value, (the above example is offset by 5 feet). Select whether or not to be prompted for specified offsets for each side, an elevation for the new polyline, and whether or not to trim existing linework that crosses the new polyline. Click OK. Select the entities that make up the building.

Prompts

Select building lines:
Select objects: pick the building linework
Draw another building envelope [<Yes>/No]?
Define Lot Edge Grade Rules

This command establishes grade rules for use in elevating lot edges with respect to a reference 3D polyline such as a road edge or other feature that must remain at its established elevations. Elevating lot edges will create 3D linework along selected lot edges in the drawing and set them at their designated elevations based on the rules established by this command (see *Elevate Lot Edges By Grade Rules* for a more detailed explanation).

This routine defines the actions to take when elevating lot edges by grade rules, establishing three categories of slopes to create (normal, minimum, and maximum) in the two possible conditions that will occur (cut or fill), for the two edges of the lots being elevated (front edges and back edges). You may also establish intermediate grade breaks along the side lot lines by adding or editing additional grading rules in the middle windows. You define both cut and fill conditions in this routine, and the *Elevate Lot Edges By Grade Rules* command will use the appropriate condition based on whether the lot edge is in cut or fill at any given location with respect to a selected reference grade line such as a road edge or other feature.

Prompts

On execution, the routine prompts for a grade rules filename (.grr) to create if new, or select an existing .grr file. Once chosen, the following settings dialog will appear:

![Define Grading Rules dialog box]

Options:
- **Slope Type**: Choose which type of slope to define, either *percent*, *ratio*, or *vertical difference*.
- **Normal slope**: Set the desired slope to use in initial lot line elevation. This is the slope that is applied whenever
you first execute *Elevate Lot Lines By Grade Rules*. Note that positive slope values are from the reference grade line **up** to the front lot line, negative slope values are from the reference grade line **down**, and may be set either positive or negative for either cut or fill conditions. This is useful to force positive drainage toward a roadway, even where the reference grade line is in a fill condition.

**Min/Max Slope:** These slope values are the limits for automatic adjustment in balancing the final grading of the lots in the *RoadNET* routines. The lot lines' slopes are adjusted to values between these two limits to achieve balanced cut and fill, and if balance is not achieved within these limits, then the entire site is raised or lowered to reach a balanced condition.

**Side Line Grade Breaks:** The middle windows in the dialog allow you to add, edit, or remove additional grade breaks along the side lot lines and are established at a distance from the previous grade break (either the front line or the previously defined break point), at a given slope (again, defined using percent, ration, or vertical difference).

**Back Slopes:** These values are for establishing the back lot lines' slopes from the last encountered grade break (either the front line, or intermediate grade breaks).

**Back Lot Edge At Existing Ground:** Selecting this option will make the back line slopes portion unavailable, and establish their elevations at the existing grade in their location. This will also prompt for selection of the existing surface model when executing the *Elevate Lot Lines By Grade Rules* routine to establish the required elevations along the back lot lines. Besides locating the back lot corners at the existing ground, this option will also drape the back lot edge on existing ground and add vertices into the back lot edge as needed to follow any undulations in the existing ground surface.

**Pulldown Menu Location:** 3D Data >> Elevate By Grade Rules

**Keyboard Command:** roadnet_grr

**Prerequisite:** None.

---

**Elevate Lot Edges by Grade Rules**

Elevating lot edges is useful to establish final grading for subdivisions or selected lot boundaries, and is also used in the *Road Network* routines by linking to the grade rule file. Once this final grade is established (by executing *Triangulate and Contour* selecting the elevated 3D lot lines as source objects), there are options to balance cut and fill by adjusting the lot lines' elevations based on the settings established in the grade rules (.grr) file. The initial elevation of lot lines will apply the normal slope, and the balancing routines will only adjust within the limits established by the minimum and maximum slope settings in the .grr file.

Consider the following example: you have a small subdivision with lot lines established using *LotNET* or other routine, and wish to elevate them with respect to the edge of the proposed roadway. Initially, the lot lines are at zero elevation. In this example, you will use the back edge of the sidewalk that is established as part of the roadway cross section template that creates all linework, at proposed grade based on the design profile of the roadway, and you wish to maintain this edge of walk at its design elevations.

---

*Small Subdivision Design with Roads and Lots*
Detail of roadway and lot edges

Execute the routine, and you will be prompted for some initial information:

![Elevate Lot Edges dialog box]

Specify the distance away from the reference grade line to seek the front lot lines to elevate and establish the layer to place the elevated lot lines on. This retains the original 2D zero-elevation lot lines to use in annotation, etc. on their original layers.

**Prompts**

Select reference elevation polylines.
Select objects: select reference 3D polyline with elevations
Select lot linework to elevate.
Select objects: select lot lines to elevate, including side lines and rear lines
Loading edges...
Loaded 826 points and 2250 edges
Created 1425 triangles
Elevated 18 lot edges.
Pulldown Menu Location: 3D Data >> Elevate By Grade Rules
Keyboard Command: elevate_lots
Prerequisite: 3D reference grade line, lot lines to elevate

Elevate Pads by Grade Rules
This command sets the elevation of closed polylines at a specified slope from reference 3D polylines. For each closed polyline, the program finds the nearest offset to a reference polyline. Then the pad polyline is elevated using the reference polyline elevation at this nearest offset position and applying the vertical offset as the slope times the offset distance.

The Reference Elevation has three methods. Elevation At Middle uses the middle position of the pad polyline segment that is on the frontage side of the pad and locates the station along the reference polyline that is at the perpendicular offset from this position. Highest Elevation takes the frontage segment of the pad polyline and checks the station range for this segment along the reference polyline to find the highest elevation within this range which is used as the elevation reference. Likewise, Lowest Elevation uses the lowest elevation on the reference polyline in front of the pad.

The program prompts for the existing surface triangulation file which is used to compare to the reference elevation and choose between using the specified cut or fill slope from the reference elevation to the pad. This feature allows you to have steeper slopes in cut than fill conditions to help with site balancing.

The Min and Max Slopes are stored with the pad polylines for use by the site balancing option in Calculate Total Volumes in SiteNet. These slopes are used as grading rules to make sure the pad stays within this slope range from the reference polyline when the pads are raised or lowered during the site balancing. The Min and Max Slopes are not used during the Elevate Pads By Grade Rules which only uses the Cut/Fill Normal slopes. Use the Edit-Assign Grade Rules command to edit these slopes and elevation reference info that is assigned to the pad polyline.

The Assign New Layer option changes the original layer to the specified layer for the elevated pad polylines. The Retain Original Polyline option creates new elevated polylines and leaves the original polylines unmodified.
Prompts

**Select Existing Ground Surface** Pick the existing triangulation surface
Select reference elevation polylines.
Select objects: select reference 3D polyline with elevations
Select pad polylines to elevate.
Select objects: select pad polylines to elevate
Loading edges...
Loaded 826 points and 2250 edges
Created 1425 triangles
Elevated 4 pad polylines.

**Pulldown Menu Location:** 3D Data >> Elevate By Grade Rules
**Keyboard Command:** elevate_pads
**Prerequisite:** 3D reference grade line, closed polyline pads to elevate
Edit-Assign Grade Rules

This command allows you to elevate other types of linework (besides lot edges and pads) with respect to a single reference elevation and offset point (or two single points if elevating a previously-elevated object using Lot Edge rules). This differs from the typical *Elevate Lot Edges By Grade Rules* in that instead of referencing the object to a reference line of constantly changing elevation, you will be setting a single point (or two single points) as a starting reference value.

You choose the linework you wish to elevate and establish for it a reference elevation and offset, if any. You may enter these values directly, or pick an object from the screen to establish the reference. If you leave the fields at their default of 0.000, you will elevate the selected object with respect to that zero reference elevation, so make sure that you have some valid reference data set in the fields. If you are elevating an object that has not previously been elevated using *Elevate Lot Edges By Grade Rules*, you will establish a single reference point/offset. If elevating a previous "Lot Edge Rules" object, you will establish two reference points/offsets, one for the front, and one for the back. You will also establish the grade rule for the back portion in addition to a single set of rules for a 2D object. (see dialogs below for differences).

The settings work much the same as the other grade rules (lot edges and pads) except that instead of elevating things based on a linear, changing reference elevation line, you are setting a single point of reference (or two single points) to elevate the selected object.

**Prompts**

*Select grade polyline:* *select the linework you wish to elevate*

If the selected object has not been previously elevated using *Elevate Lot Edges By Grade Rules*, you are then presented with the following dialog to establish the relationship of the selected linework to a reference elevation and offset. You may enter the values directly, or pick a point in the drawing and the values are calculated from the picked point.

If selected object has been previously elevated using *Elevate Lot Edges By Grade Rules*, you will be presented with the next dialog, which illustrates the difference in the two cases:
The fields and their values function the same as those in *Define Lot Edge Grade Rules*, so please refer to that command for more information.

**Pick reference point:** *Osnap on* select a point in the drawing as a reference, and the values are calculated and populate the dialog fields for you.

**Select grade polyline (Enter to end):** select another, or press Enter to conclude selection

**Pulldown Menu Location:** 3D Data >> Elevate By Grade Rules

**Keyboard Command:** edit_grades

**Prerequisite:** linework to elevate

### Convert Spot Elev To Points

This command takes spot elevation entities with zero elevations and assigns them elevations according to corresponding elevation labels.

This dialog box allows you to choose the format of the spot elevations entities that you want to convert.
Output:

**Carlson points**: creates Carlson points at elevation of spot and stores them in coordinate file

**AutoCAD points**: creates AutoCAD point objects at elevation of spot

**Is spot indicator a part of the elevation label?**

If set to "Yes", four choices for Spot indicator are available to select from:

- **Text insertion point**: uses the insertion point of the text for the location of the new point
- **Text decimal point**: uses the decimal point in the text for the location of the new point
- **Text plus sign**: uses the plus sign in the text for the location of the new point
- **Text letter x**: uses the letter x in the text for the location of the new point

If set to "No", seven choices for Spot indicator are available to select from:
Linework leader: creates a data point at the end of a leader

Linework cross: creates a data point at the intersection of a linework cross

Text plus sign: creates a data point at the insertion point of a text plus sign

Text letter x: creates a data point at the middle of a text letter x

AutoCAD point: creates a data point at the node of an AutoCAD point

Circle or arc: creates a data point at the center of a circle or arc. If a circle is composed of two 180-degree arcs, however, it only creates 1 data point

Closed linework: creates a data point at the geometric center (centroid) of closed linework, such as a square or triangle shape

Block References:

Process Block References: If check box is cleared, Carlson Civil searches only text entities for elevations, but if checked, Carlson Civil will search block references for elevations that are stored as attributes of a block. Use this option if the elevation is an attribute and the symbol designating the location of the spot elevation are both part of the block definition.

Expand Block References: Use this option to search block references when the elevation is stored as an attribute of a block, but the symbol designating the location of the spot elevation is a different block or even other geometry that is not defined within a block.

Base elevation: The value entered here is added to the existing spot elevations for all newly created points. Often, elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing. Note: The base elevation will not be added to any elevations that are closer to the base elevation value than they are to 0; e.g. if a base elevation of 500 is specified, 500 will be added to elevations like 23.4, 45.5, etc, but will not be added to elevations like 456.4 or 468.9.

Prefix Filter: Carlson Civil examines all selected spot elevations for prefixes or suffixes. If they are all the same, the command proceeds, but if there are different prefixes and/or suffixes found, the Prefix Filter dialog box is invoked. This dialog box allows you to select which prefixes and/or suffixes to use to create spot elevations, and also allows you to use different offset values for each.
Prompts

Starting point number <1>: press Enter
Select TEXT, MTEXT spot elevations to process and any associated leader lines:
Select objects: pick entities to process
Pre-processing entity #40 of 40...
Filtering text entities
Processing elevation #40...
Converted 40 spot elevations.

Pulldown Menu Location: 3D Data
Keyboard Command: spotelv2
Prerequisite: Spot elevations

Draw Spot Elevations

This command creates spot elevation labels based on user settings.
**Label Style:** This option at the top of the dialog determines which options are available in the rest of the dialog.

**Label with Leader:** This option draws a leader between the spot location and the label. The style of the leader is controlled by the current DIMSTYLE settings.

**Label with Symbol:** Draws the specified symbol at the spot with the label off to the side.

**Carlson Point:** This option creates a Carlson point entity with the point#, elevation, description attribute block and stores the point to the current coordinate file.

**Label Decimal on Point:** Draws only the elevation label and positions the label so that the label decimal is on the spot.

**Label Insertion on Point:** Draws only the elevation label and uses the spot location for the insertion point of the label.

**Symbol:** Specify the symbol to be used for the location of the spot elevation. If Draw with Leader is selected, the use of a symbol is automatically disabled. Along with the symbol name, you can also set the **Size Scaler** to size the symbol and the **Offset Scaler** to control the offset between the symbol and the label. The **Prompt For Symbol Angle** option allows you to rotate the symbol. Otherwise, the symbol is drawn horizontal to the current twist screen.

**Leader Segments** controls how many leader segments the program will prompt for. **Place Label Along Leader** draws the label along the leader instead of horizontal off the end of the leader. **Leader Horizontal Tick** draws a short horizontal segment at the label end of the leader. **Arrow Scaler** controls the size of the arrowhead.

**Draw Point Node:** Specify whether to create a node (point entity) at the spot.

**Options:** Under Options, there are settings to control the layer, text style, text size and prefix/suffix for the labels. **Box Labels** controls whether to draw a box around the label and **Box Scaler** controls the size of the box. **Locate Label On Real Z** sets whether the label and symbol are placed at the spot elevation or at zero elevation. There are several settings for fields to prompt for when placing each spot label including prefix, suffix, position and angle.

**Attribute Block:** This option uses a block with attributes to draw the spot elevations. This allows you more control of the label layout. There is one default spot elevation attribute block called spot_z1.dwg in the Carlson Support folder. To customize the layout, open the attribute block drawing, make your edits and then save the drawing. The attribute block uses three attribute definitions: Integers, Decimals, Suffix. Integers is for the elevation digits to the left of the decimal point. Decimals is for the digits to the right of the decimal point. Suffix is a text description.

**Placement Method:**

**Individual:** Prompts the user for a screen pick or a point number to specify the location of the spot elevation.

**Point Range/Group:** Draw spot elevations at the specified point numbers or point group name from the current coordinate file.
Interval: Prompts the user to select an existing polyline and specify an interval distance to set spot labels along the polyline. It also prompts for number and interval for additional labels to be set at offset distances right and/or left of the polyline.

Use Reference:
Off: User is prompted to supply elevation for each new spot elevation.

Single Surface File: Prompts user to specify the triangulation or grid surface model file to read the elevations from. Spot elevations created with this method are automatically updated if the surface model elevation changes.

Two Surface Difference: Prompts user to specify an existing surface file and a design surface file, and labels the elevation difference between the two.

Slope Percent/Ratio From Point/Polyline: These methods allow you to set the spot elevation by a slope percent or ratio from a reference point/polyline. These methods have another option for whether to Prompt for Slope which will prompt for the slope from the reference for each spot. Otherwise, the Slope From Reference setting in the dialog is used. When using the Polyline reference method, the program finds the station-offset of the spot point along the polyline and uses the elevation of the polyline at that station for the reference.

Link To Reference applies to using a surface file or 3D polyline for the spot elevations. This link option will automatically update the labels when the reference surface file or 3D polyline change.

The Integers setting controls how many decimal places to the left of the decimal point to label and the Decimals settings controls how many decimal places to the right of the decimal point to label.

Prompt for Prefix/Suffix: These options will prompt for the labels for each point which is useful when labeling different kinds of spots.

Prompt for Label Position: When using Label With Symbol style, this option will prompt for where to place the label for each spot.

Prompt for Elevation: Prompts to enter the elevation for each spot. Otherwise, the elevation of the picked point is used.

Prompt for Label Angle: This option allows you to rotate the label for each spot. Otherwise, the label is drawn horizontal to the current twist screen.

Vertical Offset adjusts the elevation label by the specified amount.

Additional Label has separate settings for Vertical Offset, Prefix and Suffix which allows for labeling two elevations for the same spot such as labeling both bottom and top of curb.

The Save and Load buttons write and recall the settings to a .LSE file so that you can store different label styles and share them.

Pulldown Menu Location: 3D Data
Keyboard Command: labspot
Prerequisite: None

Spot Elevations By Surface Model

This command will calculate the Z coordinate of any point that falls within the surface model. Use this command to calculate the elevations for points of a design for slope staking or for putting spot elevations on a topography map. The calculated points can be stored in the current coordinate (.CRD) file. A surface model is either selected from a grid (.GRD) or triangulation (.TIN or FLT) file or internally calculated from the existing entities on the drawing.

Spot elevations can be calculated at various user-specified points or at a specific interval. For random spot elevations, the user picks or enters the X,Y coordinates for each spot elevations. The elevation at the current position of the crosshairs is displayed in real-time in a small window. For interval spot elevations, the alignment for the intervals is defined by a polyline that must be created before starting this routine.

Prompts

Source of surface model (File/<Screen>)? press Enter Use the File option to select a grid (.GRD) or a triangula-
tion (.TIN or .FLT) file.

**Layer for points <POINTS>: press Enter**

**Add spot points to Coordinate File (Yes/<No>)?** Yes This option stores any points created in this routine to a .crd file and draws Carlson point entities.

**Draw nodes only (Yes/<No>)? press Enter** This prompt only appears if Add points to Coordinate File is off. This option either draws only POINT entities or an X mark and elevation text.

If you specified the use of a file for the surface model, you are then prompted to select the surface model file.

If you specified the use of Screen entities, you are prompted for:

**Pick Lower Left limit of Surface area:**
**Pick Upper Right limit of surface area:**

then the following dialog box appears with the settings to make a 3D Grid file:

![Make 3D Grid File dialog box](image)

For picked point spot elevations:

**Random spot elevations or interval along pline (<Random>/Interval)? press Enter**

**Enter or pick point (Enter to end): pick a point**

**Enter or pick point (Enter to end): press Enter**

For spot elevations along a polyline:

**Random spot elevations or interval along pline (<Random>/Interval)? Interval**

**Pick the centerline polyline: pick a polyline**

**Interval along polyline <50.0>: 25**

**Number of left offsets <0>: 1**

**Enter left offset interval <25.0>: 10**

**Number of right offsets <0>: 2**

**Enter right offset interval <10.0>: press Enter**

![Spot Elevations with Add to Coordinate File off and Draw Nodes Only off](image)
Interval spot elevations for points 1-32
"Random" spot elevations for points 33-37

Pulldown Menu Location: 3D Data
Keyboard Command: spotelv
Prerequisite: Surface entities or a grid (.GRD) file

Adjust Elevation Labels
This command has several functions that allow you to modify spot elevation labels.

The **Remove Base Elevation** function removes the base elevation amount from the labels. For instance, often elevations are abbreviated to save space. If every elevation in a drawing is in the 500's instead of labeling every elevation 523.5, 543.3, 537.2 sometimes you may wish to have them displayed as simply 23.5, 43.3, 37.2. This command allows you to adjust the labels by a given amount, such as 500, to every label elevation. This does not affect the actual elevation of entities in the drawing or in the associated surface model file.

The **Add Base Elevation** function is the reverse of Remove and applies when the labels are missing the base elevation and you want to add this elevation into the labels.

The **Offset Elevation** function adds the specified offset amount to the elevation labels and applies when elevation labels need to be adjusted by a fixed vertical offset.

The **Set Integer Digits** function sets the number of digits to the left of the decimal point for the elevation labels.

The **Set Decimals** function sets the number of digits to the right of the decimal point for the elevation labels.
Prompts

Select a sample elevation label: select single label to identify the source layer to process
Select spot elevation labels to process.
Select objects: select the text to process

Pulldown Menu Location: 3D Data
Keyboard Command: adjust_elevation_labels
Prerequisite: Spot Elevation label text

Elevate Text
This command sets the elevation of text entities by reading the elevation value from the text label. For example, this command can elevate spot elevation labels. Having the text entities at real elevation instead of zero can be useful for viewing in 3D or using for surface modeling.

Prompts

Select text to elevate.
Select objects: pick text entities
Elevated 12 text entities.

Pulldown Menu Location: 3D Data
Keyboard Command: ztext
Prerequisite: None

Interpolate Points
This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations. (To interpolate elevations the points picked must be at their real Z axis elevation.)

Prompts

Interpolate Elevations [Yes]/No]? press Enter
Point w/elevation to calculate from?
Pick point or point number: 3
2nd Point w/elevation?
Pick point or point number: pick a point
Number of Segments/Divisions: 5
The command then locates 4 points.

Pulldown Menu Location: 3D Data > 3D Points
Keyboard Command: divlin
Prerequisite: Execute Drawing Setup to set defaults. Locate two points to divide between and if you want to interpolate elevation they should have a real Z axis elevation.

Elevation Between Points
This command interpolates new points between two reference points at a single elevation or elevation interval. The routine uses the elevations of the two reference points together with the target elevation to figure the interpolation distance. For example, with one reference point at 100, the other reference at 104 and the target at 101, then the new point will be created 1/4th the distance from the first reference point towards the second reference. The target elevations are used as elevations for the new points.

Prompts

Point to interpolate from.
Pick point or point number: pick a point
Point to interpolate to.
Pick point or point number: pick a point
Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter elevation interval: 1

Pulldown Menu Location: 3D Data > 3D Points
Keyboard Command: addptz
Prerequisite: None

Interpolate Entity
This command divides the distance of a LINE, ARC or PolyLINE and locates points at the computed distances. It also interpolates elevations (To interpolate elevations the points picked must have an AutoCAD or real Z/elevation). The figure below shows a graphic example.

Prompts

Interpolate Elevations <Y>: press Enter
Point w/elevation to calculate from?
Pick point or point number: 1
2nd Point w/elevation?
Pick point or point number: 2
These points don't have to be on the entity selected to divide.
Select Entity to Divide: pick point on entity
Number of Segments/Divisions: 4
The command then locates 3 points along the selected entity.
After selecting the points above (top), new points are located along the selected entity (above, bottom).

**Pulldown Menu Location:** 3D Data >> 3D Points

**Keyboard Command:** divent

**Prerequisite:** Two elevation points and the entity to divide between.

---

**Points by Slope Ratio**

This command allows you to locate points by defining a slope from a reference elevation. There is an options dialog where you can define the slope format as percent or ratio. Enter the slope as positive for up, negative for down. You can also choose to enter elevation difference (vertical) instead of a slope. Or match the slope between two other points.

There are several difference methods for defining the X,Y location for the points.

**Screen Pick:** Prompts for a reference starting point and then you screen pick the new points to create and enter the slope from the reference.

**Direction and Distance:** First pick the starting point. If the picked starting point is at zero elevation, the program will prompt for the reference elevation. Next pick a point for the direction. Then enter the slope and the horizontal distance.

**Interpolate Between Points:** First pick the starting point. If the picked starting point is at zero elevation, the program will prompt for the reference elevation. Next pick the second reference point. Then enter the slope and the number of points to create between the two reference points. This number of points will be evenly interpolated between the reference points.

**Follow Polyline:** This method is similar to Screen Pick except that instead of using the straight line distance between the reference and target points, you pick a polyline to get the distance. The program gets the distance by projecting the reference and target points onto the polyline and then following the polyline between these projected positions.

**High/Low Between Points:** With this method, you specify two reference points and two slopes. On the line between these two reference points, the program locates the point where the two slopes intersect.
Prompts

Slope ratio + for uphill - for downhill, Start point should be 3D.
Slope Ratio (?:1) <2.0>: 1
Starting point ?
Pick point or point number: screen pick a point
Direction Point: screen pick a point
Enter Hz Distance or [I]nterpolate to Direction Point <I>: press Enter
Horizontal Dist: 214.94
Number of Points to Interpolate <2>: 5
Start Point Elevation: 0.0
End Point Elevation: 214.942
Difference in elevation: 214.942 Elevation add: 42.9884
Select/<Enter Point Elevation <42.99>: press Enter

Pulldown Menu Location: 3D Data > 3D Points
Keyboard Command: SLP
Prerequisite: None

Create Ridge Polylines From Contours

This command creates 3D polylines along the tops of ridges and in the bottom of drainages for more accurate modeling of the surface.
**Draw Options:** Specify whether to draw Ridge/Valley segments, Summit/Pit segments, or all. Ridge/valley segments travel along the tops of ridges or bottom of valleys and are extracted from the contours lines by finding acute vertices and looking to the next adjacent contour for the corresponding acute vertex. Summit or pit segments model closed polyline contours and extend the trend either upward or downward to the peak or bottom point in the geometry.

**Extraction Type (Significant and Full):** Significant segments are those segments that fall into relatively flat areas of the triangulation (large open spaces between the contours). Use this setting to reduce the number of segments generated by this command. Full extraction will model all segments.

**Minimum Segment Count and Branch Length:** Use this setting to prevent small segment branches from being generated. This can reduce the occurrence of errors in the output.

**Layer Selection:** Specify the layer that the ridge/valley and summit/pit polylines will be drawn on. You may choose the select button to specify from the list of existing layers, or specify a new layer by simply typing the new layer name.

**Density Multiplier:** The quality of output produced by this command is directly proportional to vertex density of contour polylines. This multiplier can be used to temporarily increase contour vertex density for the duration of calculations at the cost of additional processing time. Setting this multiplier to higher values generally reduces occurrence of errors in the output.

**Ignore Zero Elevations:** select this to ignore linework set at zero elevation.
Pulldown Menu Location: 3D Data
Keyboard Command: cs_extract
Prerequisite: Contours with ridges and valleys

Create Breaklines From Triangulation
This command creates 3D polylines along the tops of ridges and in the bottom of drainages for more accurate modeling of the surface.

Threshold Angle: Specify the minimum angle between adjacent triangles in the surface model to generate a breakline in the drawing.

Layer: Specify the layer to draw the breaklines on. You may type a new or existing layer name, or press the Select button to choose from a list of existing layers.

Once you press OK, you will be asked to select the triangulation file to process. Once selected, the routine draws the breaklines on the indicated layer.
Offset 3D Polyline

This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are four offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

Finally, the Surface method allows you to offset the 3D Polyline to intersect a target surface defined by a triangulation or grid file. This functions much like the Design Pad Template command on the Surface menu, but without creating side slope faces; only the intercept (or "daylight") line is created.

Prompts

Enter the offset method [<Interval>/Constant/Variable/Surface]: press Enter
Vertical/<Horizontal offset amount>: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter
Pulldown Menu Location: 3D Data
Keyboard Command: offset3d
Prerequisite: 3D polylines to use for selection; surface file for Surface method.

**Fillet 3D Polyline**

This command fillets two segments of a 3D polyline (or two un-joined 3D Polylines) with the given radius. AutoCAD's FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

There are two processing modes: corner and intersection. The corner mode works like the standard Fillet command except that it's in 3D. The intersection mode works at the intersection point between two 3D polylines. One polyline is set as the main polyline and the other as the side polyline. The main polyline is used for reference only and is not modified. The side polyline is modified to fit in the fillet radius. The intersection mode works for crossing and T intersections. An application of the intersection mode is for curb 3D polylines at road intersections.

**Prompts**

Fillet corner of a polyline or intersection of two polylines [<Corner>/Intersection]? press Enter
Enter fillet radius <10.00>: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Pulldown Menu Location: 3D Data > 3D Polyline Utilities
Keyboard Command: fillet3d
Prerequisite: 3D polyline

Join 3D Polyline
This command joins 3DPOLY entities into a single 3D polyline entity. The routine requires that two endpoints be coincident, at the same elevation. A similar function is obtained with the Join Nearest command on the Edit menu, but will allow options to join across gaps and various options for treating the resulting common endpoint.

Prompts
Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first 3 segments added to the polyline.

Pulldown Menu Location: 3D Data and Edit >> 3D Polyline Utilities
Keyboard Command: join3d
Prerequisite: 3D Polylines to use for selection

Merge Crossing 3D Polylines
This command works with 2 crossing 3D polylines, adding one or more vertices to one of them at the virtual point of intersection to match the elevation of the other. The 3D polyline that is vertically unchanged is referred to as the "Main 3D polyline", the 3D polyline that is edited is referred to as the "Side 3D polyline." The command uses the 2 vertices on the Main 3D polyline on either side of the virtual intersection to determine an interpolated elevation on the Main 3D polyline at the point of virtual intersection, and adds a vertex on the Main 3D polyline at that location with the calculated elevation, but the vertical characteristics of the Main 3D polyline are otherwise unchanged. The Side 3D polyline gets a new vertex at the virtual intersection with the same interpolated elevation, thereby changing it's vertical definition as much as necessary to match. The characteristics of the transition are controlled by the settings in the Merge Crossing 3D Polylines dialog box.

Merge Crossing 3D Polylines
Transition PVI Distance
Transition VC Length
Add Main Road Crown Onto Side Road
Left Side Offset
Right Side Offset

Transition PVI Distance: This option creates 2 additional vertices on the Side 3D polyline, each at the specified distance from the virtual intersection, and both with the same elevation as the vertex at the virtual intersection, essentially creating a flat section.
**Transition VC length:** This option creates a vertical curve for the transition, passing through the interpolated elevation at the virtual intersection. The start of the vertical curve is the specified value from the virtual intersection, as is the end, so the overall length of the entire vertical curve is actually twice the value specified in the dialog box.

**Add Main Road Crown Onto Side Road:** This option creates the transition by assuming the Main 3D polyline is a crowned roadway, and creates corresponding additional vertices on the Side 3D polyline.

**Prompts**

**Select the Main 3D polyline:** *pick the 3D polyline that will determine the crossing elevation, but will remain essentially unchanged*

**Select the Side 3D polyline:** *pick the 3D polyline that is be changed to match the Main 3D polyline elevation at the virtual intersection*

**Merge Crossing 3D Polylines dialog** Adjust variables as desired in Merge Crossing 3D Polylines dialog box, pick OK.

**Pulldown Menu Location:** 3D Data  
**Keyboard Command:** merge3d  
**Prerequisite:** 2 crossing 3D polylines

---

**3D Polyline by Slope on Surface**

This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

**Prompts**

**Enter the polyline layer** `<SLOPE ROAD>`: *press Enter*

**Select the Grid File dialog**

**Reading row** > 51  
**Extrapolate grid to full grid size (Yes/<No>)? Y**

**Limiting length for polyline (Enter for none):**

**Pick origin point of 3D polyline:** *pick a starting point*

**Direction of 3D Polyline (<Up>/Down)? press Enter** The slope must go either uphill or downhill.

**Direction of 3D Polyline facing up slope (<Left>/Right)? R** Imagine facing uphill. Do you want the polyline to go to the left or right?

**Enter the design slope:** 10 This value is in percent slope.
Min/Max Slopes 3D Polyline
This command checks 3D polylines to make sure slopes are within the specified range. For any segment that is outside the range, the program will set the elevation of the polyline vertex to put the segment within range. This routine could be used on a 3D polyline for a ditch to make sure the slope has a minimum grade. Also this routine applies to a 3D polyline for a road that has a maximum grade.

Prompts

All slopes up, down or either [Up/Down/<Either>]? U for up
Min slope percent: 1
Max slope percent: 9
Select polylines to process.
Select entities: pick 3D polylines
Changed 3 polylines.

Follow TIN Edges
This command creates a polyline by connecting edges in a triangulation to approximately follow the path of an existing polyline. One application is to create an inclusion or exclusion perimeter for carving out a portion of a triangulation surface. By having the polyline follow the triangulation edges, the polyline can be applied to the triangulation without trimming edges or adding points. Otherwise, when the polyline doesn't follow the triangulation edges, the program will embed the polyline into the triangulation by draping the polyline onto the triangulation.
Prompts

Enter the polyline layer <INCLUSION>: PERIMETER
Select TIN File Select a triangulation file
Select boundary polyline to follow: pick a polyline
Loading edges...
Done.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: tinpline
Prerequisite: a polyline

Extend To Elevation
This command extends the end segment of a 3D polyline or line until the segment reaches the specified elevation. The slope for the extension is user-specified and defaults to the existing segment slope.

Prompts

Select line or polyline to extend: pick a 3D line or polyline
End point elevation: 496.130
New elevation: 495
Slope to extend <-1.482>: press Enter
Select line or polyline to extend (Enter to end): press Enter

Pulldown Menu Location: 3D Data
Keyboard Command: extend2z
Prerequisite: 3D linework
Break 3D Polyline by Surface

This command breaks 3D polylines against a surface. The surface is defined by a 3D grid or triangulated surface model which can be selected from a .grd, .flt or .tin file. Alternately, the user can select 3D entities on the screen from which the program internally calculates a 3D grid. This routine is one step in 3D polyline design. In this example, a valley fill is designed using 3D polylines as follows:

1. Draw 3D Polyline - draw a 3D polyline at elevation 1450 across valley
2. Offset 3D Polyline - offset the 3D polyline at 2:1 slope and 10:1 for benches and top
3. Break 3D Polyline by Surface - trims the 3D polylines by the valley sides
4. Draw 3D Polyline - with OSNAP endpoint, draw 3D polyline perimeter around 3D polylines ends
5. Make 3D Grid File - create 3D grid file of fill surface
6. Plot 3D Grid - draw the 3D grid using 3D polyline perimeter as inclusion polyline
7. Viewpoint 3D - creates the last figure view

Prompts

Source of surface model (File/<Screen>)? press Enter The File option allows you to choose the .grd, .flt, or .tin file that models the site. Otherwise, a grid will be calculated by picking the grid location and selecting surface entities on screen (e.g., contour polylines). Using the File option can be quicker because the surface is already calculated. Also the .grd file can be drawn to preview the existing surface.

Pick Lower Left limit of surface area: pick a point
Pick Upper Right limit of surface area: pick a point
Make GRiD Setting Dialog OK
Select polylines to clip.
Select objects: pick the 3D polylines
Select surface entities.
Select objects: select objects that define the surface.
Erase polyline below surface (<Yes>/No)? press Enter If you answer yes, the segments of the polylines below the surface will be erased from the intersection, if any, of the polyline with the surface. Otherwise the polylines will only be broken into separate polylines at the intersection.
Specify layer names (Yes/<No>)? press Enter If you answer yes, you will have the option to place the broken polylines into different layers.

Before Break 3D Polyline by Surface

After Break 3D Polyline by Surface
Pulldown Menu Location: 3D Data
Keyboard Command: surfbreak
Prerequisite: Plot the 3D Polylines to use for selection and entities that define a surface.

Add Points At Elevation
This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts
Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines

Label Pad Elevation
This command creates elevation labels inside closed polylines such as building pad polylines. The elevation value for the label comes from the elevation of the polyline. In the dialog, there are settings to control the label prefix, suffix, decimal place precision, text size position, orientation, layer and style for the labels. For Position, the Center of pad option creates the labels in the center of the polyline and the Edge of pad creates the label along the top segment of the polyline and draws a leader from the label to the polyline. For Orientation, the Horizontal option creates the label horizontal to the current twist screen and the Align With Pad option rotates the label to align with the longest segment of the polyline. The Use Polyline Layer option will use the layer of the polyline for the label layer. The Erase Old Labels option erases previous labels when labeling the same polyline another time. The Additional Elevation Labels are optional labels that are a fixed vertical offset from the polyline elevation. For example, you can use this option when the pad polyline elevation represents the finished floor elevation and you
also want to label the basement elevation that is at a fixed offset.

Pulldown Menu Location: 3D Data > Label Polylines
Keyboard Command: labelpad
Prerequisite: Closed polyline with assigned elevation

Update Pad Elevation Labels
This command reads all previously created Pad Elevations, and updates their values if their associated Pad Polyline elevations have been changed.

Pulldown Menu Location: 3D Data >> Label Polylines
Keyboard Command: update, labelpad
Prerequisite: Previously created pad elevation(s)

Label Elevations Along Polyline
This command labels point elevations and aligns with a polyline based on settings shown in the dialog. These settings can be divided into five groups.

Label Settings: The Source of Elevations are read from Carlson points drawn on the screen, polyline vertices, elevations of grade break vertices and can also be picked on the screen. The Side for Labels is relative to the direction the polyline is drawn. Labels can be aligned horizontally, parallel or perpendicular to the polyline or according to the picked alignment. The Offset distance scalar offsets the label from the actual point.
**Text Settings:** The labels will be drawn on Layer with selected Style. The Text size scalar is relative to the current horizontal scale, which is set in Drawing Setup. These scalars are multiplied by the horizontal scale to obtain the actual drawing units. The number of Integers and Decimals can also be specified along with Prefix and Suffix for the main elevation label.

**Leader Settings:** The Leader Settings are used to Draw Leader with Arrowhead on the leader Layer with length of leader equal to Leader Scaler. The option Draw text above leader extends the leader tick to the length of the label.

**Additional Settings:** Draw box around label draws box around the elevation label. Flip text for twist screen changes the text direction if the text is drawn upside down. If the option Ignore zero elevation is on zero elevation labels will be ignored. The Carlson points or picked points are beyond Maximum offset to use will be ignored.

**Additional Offset Settings:** If the Additional offset is other than 0, it will be labeled with Prefix and Suffix using the other text settings on the next line of main elevation label.

The overlapping labels can be moved using Move Elevation Labels command to remove the overlap.

**Prompts**

Label Elevation Along Polyline dialog
Select alignment polyline: pick a polyline
Select points to label.
Select objects: pick the points
The alignment polyline with points to label is shown.

**Pulldown Menu Location:** 3D Data->Label Polylines

**Keyboard Command:** elevlab

**Prerequisite:** Polyline and points

---

**Move Elevation Labels**

This command moves the selected elevation labels drawn using Label Elevations Along Polyline command with a leader. The purpose is to clean up label overlaps. To move a label, pick any one of the elevation labels text and the program will pick up all the other associated labels. Then pick the new location and while the pointer is moved, the program shows an outline of the label area. The program remembers the moved locations for each label so that when the elevation labels are redrawn, the moved locations are retained. The Restore function puts the labels back to their default position. The following graphics show the elevation labels before and after Move Elevation Labels was used to clean up the label overlaps.

---

*Chapter 6. Civil Module*
Elevation Labels with Overlap

Move a label away

Elevation Labels without Overlap

Prompts
Select elevation label to move (R for Restore): *pick a elevation label text with leader*
Pick label position: *pick a point*
Select elevation label to move (R for Restore): *press Enter to end*

Pulldown Menu Location: 3D Data > Label Polylines
Keyboard Command: move_elevlab
Prerequisite: Elevation labels drawn using Label Elevations Along Polyline command

Label Polyline High/Low Points
This command finds and labels the high, low and end points of selected 3D Polylines. This is useful for drainage studies, finding low spots for placement of culverts or inlets, checking overhead clearances, etc. The Erase Previous option will erase labels created by this routine when running again on the same polyline. The Flip Text for Twist Screen option applies to text labels that would be upside-down in the current view depending on the polyline orientation. When a polyline has elevations that go up and down, multiple high and low points can be labeled for the different local highs and lows. The Minimum Depth setting controls how much elevation difference is needed to label a local high or low point.

Prompts
Label Polyline High/Low Points dialog
Select 3D Polylines.
Select objects: *select one or more 3D Polylines*
Processing polylines ...
Done.
Pulldown Menu Location: 3D Data >> Label Polylines
Keyboard Command: elevpl
Prerequisite: 3D polyline(s)

Label Polyline Segment

This command labels the distance and slope of 3D polyline segments, or between two picked points, in plan view.

In the dialog, choose the selection method; either the Entire polyline, Polyline segment, or Any two points. Then choose the location and/or visibility for the Horizontal distance, Slope distance, Slope %, and Slope ratio, enter any desired Prefixes and/or Suffixes, and the desired decimal Precision for each. Choose whether to Draw Slope Leaders, which are arrows pointing in the direction of the slope. The Slope Direction controls whether to draw the slope leaders in the direction of the polyline, always pointing uphill or always pointing downhill. Leader Position controls whether to draw the slope leaders along side the slope label or above the label. Choose whether to Erase old annotations, and set the Text size scaler, Text offset scaler, and other related variables. Scalers are multiplied by the drawing scale to determine the actual sizes for the specified objects. Choose the Annotation layer from the drop list. Pick OK, and you are prompted to select the polyline or segment or two points to annotate.
Prompts

Set up variables as desired in Annotate polyline dialog box, pick OK. Depending on your Selection method, the prompt will either read:

Select a polyline segment to annotate: *pick the segment*

or

Select a polyline to annotate: *pick the polyline*

or

Pick first point: _nea to For snap on.

Pick second point: _nea to

Press enter to return to the Annotate polyline dialog box, in the dialog box, pick Cancel to end.

Pulldown Menu Location: 3D Data >> Label Polylines

Keyboard Command: label3dp

Prerequisite: A 3D polyline

Highlight Segments by Slope

This routine highlights segments of a 3D polyline with slopes greater than the entered slope value. The RED segments are uphill, BLUE is downhill and BLACK/WHITE is for slopes less than the target slope. The slope can be entered as percent, ratio or degree. Choose Select to select the polyline and it is colorized by slope.

Prompt
Select a polyline to highlight: *Select the 3D pline*

Pulldown Menu Location: 3D Data >> Highlight 3D Polylines

Keyboard Command: hlslope3dp

Prerequisite: 3D polylines

---

**Highlight Crossing Breaklines**

Breaklines are lines or polylines that are used in surface modeling to represent a feature such as a ridge, stream or curb. Breaklines force triangulation and interpolation to occur between the vertices of the breakline, which prevents any other triangulation line from crossing the breakline. It is important to avoid crossing breaklines in the surface model because the program cannot force triangulation along both since holding one will cross the other. Also the program cannot hold the interpolation along both because the elevation at the intersection point can be different for the two breaklines. For example, consider a breakline going from 101 to 105 and another going from 107 to 109. If these lines had an intersection at the midpoint, the elevation for one would be 103 and the other 108. This is an error that needs to be fixed by the user because those two breaklines are holding different elevations at the same point.

This command checks for intersections between the selected breaklines and then identifies any crossing breaklines by highlighting them. You can then edit these crossing breaklines before doing surface modeling such as Make 3D Grid or Triangulate & Contour.

---

**Prompts**

Ignore zero elevations [<Yes>/No]?
Reading points ...
Select surface entities to check.
Select objects: *select polylines and lines*
2915 found
Select objects: *press Enter to conclude selection*
Reading points ... 4442
122 crossing breaklines are highlighted.
Use Report Formatter [Yes/<No>]? *press Enter*
Minimum delta Z to report <0.0>: press Enter
Add polyline vertices at intersections [Yes/<No>]? press Enter

or

Found no crossing breaklines if there are none.

Pulldown Menu Location: 3D Data >> Highlight 3D Polylines
Keyboard Command: xbar
Prerequisite: Polylines

Report 3D Polyline Station/Elevation

This command reports station or elevation information on a 3D polyline. If the station information is entered the program will return the elevation at the entered station. If the elevations are entered the program will determine and report the station at which the entered elevation occurred. If the elevation entered occurs at more than one location along the 3D polyline, all occurrences of the elevation are reported.

A prompt is provided allowing you to designate a starting station, or accept the default value of <0.0>. All entry and values are recorded and are displayed in the Carlson Standard Report Viewer upon completion.

Prompts

Select 3D polyline to report: pick a polyline
Starting Station <0.0>: press Enter
Enter elevation or station (<Elevation>/Station)? S
Enter Station to calculate elevation: 100
Station: 1+00.000 Elevation: 1052.262
Enter Station to calculate elevation (Enter to end): press Enter
Select 3D polyline to report: pick a polyline Starting Station <0.0>: press Enter
Enter elevation or station (<Elevation>/Station)? E
Enter Elevation to find stations: 2140
Enter Elevation to find stations: 2144
Enter Elevation to find stations: 2150
Enter Elevation to find stations (Enter to end): press Enter
Pulldown Menu Location: 3D Data
Keyboard Command: plreport3
Prerequisite: A 3D Polyline

**Story Stake from Surface Entities**

This command creates points with cut/fill information stored in the note fields for the points. Beginning at a point and facing a specified direction, the cut/fill information describes a design surface that is defined by contours and 3D polylines in the drawing. The program prompts you to pick the starting point followed by a direction point. Then the intersections for all the contours and 3D polylines between these two points are calculated and the resulting horizontal distances and slopes are shown in a dialog. In this dialog, you can edit, add or remove these slopes descriptions. The Point Description can also be specified. When OK is clicked, a point in the coordinate file is created at the starting point with this information stored in the note file. An offset point is also created at the specified offset distance back from the starting point. At the end of Story Stake from Surface Entities, a report of all the created points and the corresponding cut/fill data is shown if the Create Report option was set. Story Stake from Surface Entities does not draw the points in the drawing. These points can be drawn using the Draw-Locate Points command.
Prompts

Pick starting point: *pick the first point*
Pick direction point: *pick the second point to determine the direction*
Pick next starting point (Enter to end): *Enter if done*

Pulldown Menu Location: 3D Data >> Story Stake
Keyboard Command: prepare_story
Prerequisite: Screen entities such as 3D polylines and contours

Story Stake By Points/Polyline

By Points
This option creates a report of cut/fill slopes and distances of a design surface from point to point. First you select the starting point. This starting position is shown as point 100 in the drawing below. Next you enter the subsequent point numbers to get the direction. The resulting horizontal distances and slopes are shown in a report dialog.
If the use Progressive Story Stake Method is turned off, the Cut/Fill, Distance and Slope is calculated from the first point to each point. The result is shown below. If it is turned ON, then it is point to point.

By Polyline

This command creates a report of cut/fill slopes and distances of a 3D polyline across a design surface. First you select the 3D polyline. The resulting horizontal distances and slopes are shown in a report dialog. The same applies
for the Progressive Story Stake Method when using the 3D Polyline.

Pulldown Menu Location: 3D Data >> Story Stake
Prerequisite: Screen entities such as 3D polylines and contours
Keyboard Command: story_report

Tag Non-Surface Points
This command allows you to tag Carlson points in the drawing so that they will not be used when creating a surface. These could be points that are far from the site, such as off-site horizontal control, or points with elevations that are not on the ground, such as a TBM taken on the top of a fire hydrant. There are several methods available to select the points for tagging as non-surface points. One key to remember is that they must be present in the drawing to be tagged.
**Range:** This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.

**Area:** This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

**Selection Set:** This option allows the manual selection of points within the drawing.

**Description Match:** This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.

**Pulldown Menu Location:** 3D Data >> Non-Surface Points
**Keyboard Command:** tagns
**Prerequisite:** Carlson points in a drawing

### Untag Non-Surface Points
This command allows you to Untag Carlson points in the drawing that have been tagged as non-surface points, so that they will again be used when creating a surface. As with tagging non-surface points, there are several methods available to select the points for untagging, and the points must be present in the drawing to be untagged.
Range: This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.

Area: This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

Selection Set: This option allows the manual selection of points within the drawing.

Description Match: This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.

Pulldown Menu Location: 3D Data >> Non-Surface Points
Keyboard Command: untagns
Prerequisite: Carlson points in a drawing

Report Non-Surface Points

This command allows you to generate a report of Carlson points in the drawing that have been tagged as non-surface points. As with tagging and untagging non-surface points, there are several methods available to select the points for the report, and again, the points must be present in the drawing to be included in the report.
Range: This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.

Area: This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

Selection Set: This option allows the manual selection of points within the drawing.

Description Match: This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.

Pulldown Menu Location: 3D Data >> Non-Surface Points
Keyboard Command: tagns
Prerequisite: Carlson points in a drawing

Non-Surface Entities
This command tags selected entities in the drawing so that they will not be used when creating a surface in commands like Triangulate & Contour. For example, you could tag a 3D polyline for a building roof so that it's not used for modeling the ground surface. There are three commands to manage these tags:
Tag Non-Surface Entities: adds the non-surface tag to the selected entities
Untag Non-Surface Entities: removes any non-surface tag from the selected entities
Report Non-Surface Entities: reports the entity type and location for any selected entities that have active non-surface tags

Prompts
Select entities to tag as non-surface.
Select objects: pick entities to tag

Pulldown Menu Location: 3D Data >> Non-Surfaces Points/Entities
Tag Hard Breakline Polylines

This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they cross these hard breaklines, even with contour smoothing turned on. For example you could tag 3D polylines that represent a wall or a curb so that the contours go straight across without smoothing curves. If contour smoothing is turned off, this tag had no effect.

Prompts

Select hard breakline polylines. (For no smoothing in Triangulate & Contour)
Select objects: Select breaklines to tag
Select objects: press Enter to conclude selection
Set 14 polylines as hard breaklines.

Highlight Hard Breakline Polylines

This command visually highlights all polylines in the drawing that have been tagged as hard breaklines.

Identify Hard Breakline Polylines

This command prompts to select polylines and reports to the command line whether they are tagged as hard breaklines or not.

Prompts

Select polyline: select polyline
Polyline is a hard breakline
Select polyline ([Enter] to End): select polyline
Not a hard breakline
Select polyline ([Enter] to End): press Enter to conclude.
Untag Hard Breakline Polylines

This command removes hard breakline description tags from polylines. These tags are used by Triangulate & Contour to identify polylines as hard breaklines. Contours are not smoothed as they cross these hard breaklines, even with contour smoothing turned on. This routine untags polylines so that contours are smoothed across them. If contour smoothing is turned off, hard breaklines have no effect.

Prompts

Select polylines to remove hard breakline tag from.
Select objects: select polylines

Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: softbrk
Prerequisite: Polylines with hard breakline tag

Surface Menu

Tag Predefined Boundaries

This command allows you to identify closed polylines to be used as inclusion or exclusion boundaries. These boundaries are applied in Surface Menu commands such as Two Surface Volumes and Triangulate & Contour. Inclusion polylines limit processing to inside the polyline(s). For example, an inclusion polyline for volumes would be the limit of disturbed area. Exclusion polylines prevent processing inside the polyline(s). For example, a building perimeter or pond surface could be an exclusion polyline for contouring. Tag Predefined Boundaries assigns a site name to polylines and flags the polyline as either inclusion or exclusion.

Many Surface commands will prompt for inclusion and exclusion polylines. The advantage to Predefined Boundaries is that you don't have to select the boundary polylines each time that you run the Surface command. Instead, the program will recognize that the boundary is already specified and will prompt "Use predefined boundary Area 1 (<Yes>/No)?" This lets you simply press enter to use your predefined boundaries. If you want to pick different boundaries, you can type N for No and select them prior to processing. When you have more than one set of predefined boundaries, the routine lets you choose from a list of the boundary names as shown in the dialog.

Prompts

Boundary name <Site 1>: Area 1
Select Inclusion perimeter polylines.
Select objects: pick the closed polylines or press Enter for none
Select Exclusion perimeter polylines.
Select objects: pick the closed polylines or press Enter for none

Pulldown Menu Location: Surface >> Predefined Boundaries
Keyboard Command: plzone
Prerequisite: Closed polyline

Identify Predefined Boundaries

Identify Predefined Boundaries identifies any polylines in the drawing that have been previously tagged as Predefined Boundaries. The Pick option prompts to pick a polyline, and if it has been tagged as a Predefined Boundary, the Boundary Type and Boundary Name are presented at the command line. The Search option scans the entire drawing for Tagged Predefined Boundaries, highlights them in the drawing, and lists their location, layer, type and name at the command line.
Predefined Boundaries are applied in Surface commands such as *Two Surface Volumes* and *Triangulate & Contour*. Inclusion polylines limit processing to inside the polyline(s); e.g., an inclusion polyline for volumes would be the limit of disturbed area. Exclusion polylines prevent processing inside the polyline; e.g., a building perimeter or pond shoreline could be an exclusion polyline for contouring. Identifying polylines that have been previously tagged as Predefined Boundaries is often helpful during surface modeling.

**Prompts**

**Pick polylines to check or search drawing [Pick]/[Search]:** press Enter for default pick method

**Select boundary polyline:** pick a polyline

**Inclusion boundary polyline for Site 1**

**Select boundary polyline (Enter to end):** press Enter

**Pulldown Menu Location:** Surface >> Predefined Boundaries

**Keyboard Command:** plzoneid

**Prerequisite:** Assigned, predefined inclusion/exclusion closed polylines

---

**Untag Predefined Boundaries**

This command removes the previously tagged predefined boundary names from selected polylines. These polylines will no longer be automatically recognized as boundary polylines.

**Prompts**

**Select polylines to remove boundary tag from.**

**Select objects:** pick the boundary polylines

**Pulldown Menu Location:** Surface >> Predefined Boundaries

**Keyboard Command:** nozone

**Prerequisite:** predefined boundary polylines

---

**Triangulate & Contour**

At the heart of nearly every land design project is at least one terrain model. These models go by several names and one of the most common is that of a "TIN" or Triangulated Irregular Network; another common name is that of a "DTM" or Digital Terrain Model. Since accurate representations of a surface model are significantly important to most land development projects, having a thorough understanding of the Triangulate & Contour controls is very important.

Surface models are generally comprised of combinations of the following general data types:

- **Points** - Most surface models are comprised of points whose coordinates (x,y,z) contribute to the formation of triangular planes that connect three points that are in close proximity to one another. Within Carlson, most points come from the Draw Field to Finish command and/or the Draw-Locate Points command. Points can be selectively filtered from the triangulation engine through the use of the Tag Non-Surface Points command.
- **Breaklines** - Breaklines (or "fault lines") are used to control the connection sequence between four points which results in two triangles. Common uses of breaklines include ravines, ditches, berms and other areas where distinct grade discontinuity occurs. The "leg" of a triangle can travel along a breakline but cannot cross the breakline. Breaklines must be in the form of 3D polylines or simple lines whose vertices or endpoints define a valid "Z" elevation. A common problem related to breaklines is when two breaklines cross one another in 3D space. In these situations, an impasse results and will result in a "crossing breakline" report. Within
Carlson, most breaklines come from the Draw Field to Finish command and/or the 3D Polyline command. Breaklines fall into one of two general categories:

– "Soft" breaklines - Unless otherwise specified, all breaklines are considered "soft" breakline. The nature of soft breaklines allows a degree of contour smoothing across the breakline itself resulting in a "weathered-" or natural-looking contour.
– "Hard" breaklines - Breaklines tagged as "hard" breaklines prevent contour smoothing through the breakline. Hard breaklines are generally used to represent man-made terrain breaks that commonly occur during excavation and construction. Breaklines can be changed to hard breaklines through the use of the Tag Hard Breaklines command.

Breaklines and other triangulate-able entities can be selectively filtered from the triangulation engine through the use of the Tag Non-Surface Entities command.

• Inclusions - Inclusions (or "boundaries") are used to identify the entities that can be used for triangulation and multiple inclusion regions can be selected for a given surface model. Entities that fall outside of an inclusion boundary and are not otherwise bound by a different inclusion boundary are ignored by the triangulation engine. Inclusion regions must be in the form of a closed 2D or 3D polylines. Within Carlson, most inclusion polylines come from the Shrinkwrap Entities command.

• Exclusions - Exclusions (or "void regions") are the antithesis of Inclusions and are used to prevent triangulation from occurring between points that are bound by an Inclusion region. Common uses of exclusion regions include building footprints and free-standing water limits (e.g., ponds). Entities that fall inside an exclusion region are ignored by the triangulation engine. Exclusion regions must be in the form of a closed 2D or 3D polylines. Within Carlson, most exclusion polylines come from the Boundary Polyline command and/or the 3D Polyline command.

Carlson provides a programming interface for these file types and also offers a third file type (*.GRD) for the representation of terrain data. See the Notes section for additional details.

The Triangulate tab provides options and settings that control the creation and analysis of the TIN itself.

**Draw Triangulation Lines:** When enabled, the program will draw the triangulation using simple line entities at the appropriate elevation(s). Use the Select button or specify the layer for these lines.

**Draw Triangulation Faces:** When enabled, the program will draw the triangulation using a collection of 3D Face entities. These 3D Faces can then be used rendering routines such as HIDE and SHADE or in Carlson routines such
as 3D Viewer Window, 3D Surface Fly-Over and Slope Zone Analysis. Use the **Select** button or specify the layer for these 3D Faces.

**Draw Slope Arrows**: When enabled, slope arrows are created within the triangles indicating the downhill dip direction as illustrated below.

![Slope Arrows Diagram](image)

Clicking the **Setup** button yields the Draw Slope Arrow Settings dialog box.

![Draw Slope Arrow Settings](image)

**Arrow Layer**: Indicate the layer to which the slope arrows are to be placed.

**Size Scaler**: Indicate a positive, non-zero value for the scale factor that should be applied to the slope arrows.

**Draw Slope Percent Label**: When enabled, the slope value (in percentage) of the triangle is labeled onto the slope arrow. Specify the desired unit suffix (e.g. "%") to apply to the end of the numerical value that is calculated from the TIN triangle(s).

**Label Decimals**: Indicate the amount of precision that is to be displayed on the slope label.

**Min Area to Label**: Indicate the smallest allowable triangle size that can be used for the slope percentage labels.

**Write Triangulation File**: When enabled (strongly suggested), an external surface model file is created which can subsequently be used for volume calculations, the creation of profiles, cross-sections and graded pads. Carlson currently provides two file types to store the DTM data created by the Triangulate & Contour routine:

1. *.TIN - The TIN file format is the default and preferred file format due to its compact file size and organizational efficiency. The Carlson TIN format is governed by Carlson and is in a binary (non-human readable) format.
2. *.FLT - The FLT file format is a legacy ASCII-based (human-readable) file format and is used in some older machine control applications.
Use Inclusion/Exclusion Areas: When enabled, the program will prompt you for inclusion and exclusion polylines and prevents the use of the Shrink-Wrap Perimeter Reduction option. These are used to further control the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and when used, must be drawn before using Triangulate & Contour. It is suggested that the height of the Command: line display must be set to show at least two lines so that the additional prompts can be easily viewed. Refer to the Notes section for additional information on Inclusion/Exclusion polyline selections.

Shrink-Wrap Perimeter Reduction: This option produces an inferred Inclusion region around the data to be selected and mimics the results of the Shrinkwrap Entities command.

Ignore Zero Elevations: When enabled, this option will filter out all data points and entities at an elevation of zero from the triangulation data set.

Specify Input/Output Elevation Range: If you would like to manually set the range over which to contour, select either or both of the aforementioned toggles. One controls the triangulation of the source data and the other for the contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

Minimize Flat Triangles: When enabled, this toggle instructs the triangulation "engine" to iterate through the triangulation permutations to minimize the occurrence of "flat" (or more precisely, horizontal) triangles. Flat triangles often occur when creating surface models from contour data. In this scenario, the often used Delaunay triangulation algorithm may produce unrealistic results. The Minimize Flat Triangle option will perform additional permutations of the triangulation network through the use of the Surface Manager > Swap Edge routine in an attempt to maximize the number of "sloped" triangles. Another option that produces similar results is the Interpolate Ridges and Valleys option.

Before: Surface made from an existing contour map with Minimize Flat Triangles disabled.
After: The same surface with Minimize Flat Triangles enabled. Note the better defined ravine and ridge definitions.

Difference: A Cut/Fill Color Map showing the regions of significant triangulation difference between the "Before" scenario and the "After" scenario of "Minimize Flat Triangles."

Erase Previous Contour Entities: In the event that a TIN needs to be recreated and Carlson-produced contours are in the drawing, three options exist that allow you to control whether or not the contour data should be removed from the drawing:

- Off - All existing Carlson-generated contours are left intact in the drawing. If these contours satisfy all of the triangulation requirements, they can be utilized by the Triangulation algorithm.
- Current Surface - Only the Carlson-generated contours that are associated with the active Triangulation file are removed from the drawing.
- All Contour Entities - All Carlson-generated contours are removed from the drawing, regardless of the surface model that created them.

Pick Reference Plane: When enabled, this option allows you to contour an overhang or cliff by changing the refer-
reference plane to a side view. The reference plane can be specified by using the View>Viewpoint 3D>View command (see the AutoCAD/IntelliCAD Help menu for additional details) or by specifying three data points on the cliff (two along the bottom and one at the top).

Highlight Breaklines: When enabled, this routine highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

Interpolate Ridges and Valleys: The intent of this routine is similar to, and is the pre-cursor of the Minimize Flat Triangles option. When enabled, this option inserts "best-guess" breaklines into the drawing which are subsequently used in the triangulation process in an attempt to minimize flat, horizontal triangles.

Interpolate Summits and Pits: When enabled, this option creates additional triangulation in a summit or pit situation to more accurately represent existing ground conditions from a surface model created from contour entities. Since the tops of hills and the bottom of pits are often not shown on existing ground contour maps, this option often helps improve the accuracy of existing terrain conditions.

Simplify Surface: When enabled, this option reduces the digital size of a surface without significantly compromising the integrity or accuracy of the surface itself. The most common application to enable this option is when using very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized.

Elevation Method: When enabled, this option reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the Tolerance factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the Tolerance factor, so the higher the Tolerance factor, the more vertices are removed and vice versa.

Preserve Breaklines: When enabled, this option analyzes the TIN by focusing on the edges; calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If its angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Weight factor is applied to the corresponding vertex, adjusting its original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Weight factor, so the greater the Weight factor. The fewer vertices that are removed, the lower the Weight factor, the more vertices that are removed.

A good rule-of-thumb that can be used when deciding whether or not to use these options is:

- If the surface contains no man-made features, use Simplify Surface option (with or without the Elevation Method option).
- If the surface contains man-made features, such as roads, use both Simplify Surface and Preserve Breaklines.

Max Triangle Mesh Line Length: Two bounds are provided to limit the length of the "legs" within a triangulation network. Based on the available data, if the edge length of a triangle exceeds the respective bound, the triangle will not be formed:

- Exterior: This value applies to triangulation lines around the perimeter of the triangulation area.
- Interior: This value applies all the other triangulation lines. Generally you would have the Exterior value larger than the Interior value.
**Draw Contours:** When enabled, the program will draw contour lines using the designated settings after triangulation process is complete. Otherwise, only the designated Triangulation operations are performed. If this option is disabled and contours are subsequently desired, use the Contours from TIN File command.

**Interval Method:** Indicate the desired elevation(s) for contours to be drawn:

- **Contour by Interval:**Specify the desired interval (e.g. every 2 feet) into the Contour Interval field.
- **Contour an Elevation:**Specify a desired elevation (e.g. a floodplain elevation or other unique elevation of interest) and set the desired value into the Contour Interval field.

**Contour Layer/Index Layer:** Specify the layer to which the contours/index contours are to be drawn.

**Contour Interval/Index Interval:** Specify the interval to which the contours/index contours are to be drawn.

**Contour Line Width/Index Line Width:** Specify the line width to be applied to the contours/index contours.

**Draw Index Contours:** When enabled, index (or "major") contours will be created with independent characteristics from the regular contours.

**Min Contour Length:** Specify the minimum linear threshold that should be used to draw contours.

**Apply Outlier Reduction Filter:** When enabled, this option attempts to remove "the jaggies" which tend to occur along long, thin triangles.

**Reduce Vertices:** When enabled, this option attempts to remove extra vertices from the contours using the Offset Distance value. The result of this action is often a significant reduction in vertex locations along the contour resulting in a more efficiently-sized and compact drawing file.

**Offset Distance:** Specify the maximum allowable distance for shifting the original contour line in order to reduce vertices. The reduced contour will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour to shift further from the original location.

**Reduce Before Bezier Smoothing:** When enabled, this option attempts to remove extra vertices from the contours before they undergo Bezier Smoothing using the Offset Distance value.

**Contour Smoothing Method:** Indicate the desired amount of smoothing (often used for existing, natural ground conditions to simulate a "weathered terrain" effect) that should be applied to the contours:
- **No Smoothing**: This option is often used for proposed, man-made surface considerations where the terrain has been shaped with earth-moving equipment. For applications where a "nature-emulated" man-made terrain is desired, refer to the Carlson Natural Regrade documentation.
- **Bezier Smoothing Factor**: This option holds all the contour points calculated from the triangulation and only smooths between the calculated points.
- **Polynomial Smoothing**: This option applies a fifth degree polynomial equation through the contour data points for a smooth transition between the triangulation faces.

**Subdivisional Surfaces**: When enabled, adjust the horizontal slider to indicate the degree of triangular subdivisions. This causes each triangle in the triangulation surface model to be subdivided into \((x + 1)^2\) triangles, where \(x = \text{Subdivision Generations}\). The mathematically generated sub-triangle vertices are raised or lowered to provide smoother contours. More generations increase the smoothness of the contours but incur increased processing time. Although this algorithm does not produce "crossing contours," it can result in undesired contours in terrain scenarios such as where graded slopes abruptly transition to nearly horizontal slopes (e.g. the sides and bottom of a detention pond).

**Bezier Smoothing Factor**: Adjust the horizontal slider to obtain a preview of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

**Highlight Depression Contours**: When enabled, use the *Setup* button to establish general configuration settings for depression contours.

![Depression Contour Settings](image)

**Layer**: Specify the layer to which the depression contours are to be drawn.

**Tick Size Scaler**: Indicate the relative scale factor that should be applied to the depression ticks.

**Tick Interval Scaler**: Indicate the desired interval scaler which controls the spacing of the depression ticks.

**Line Width**: Specify the line width to be applied to the depression contours.

**Hatch Zones**: When enabled, this option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Auto: Opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

Starting Zone: Sets the zone with which to begin the application of the setting defined in this dialog. For instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

Set Values: Enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

Starting Value: Sets the elevation of the beginning zone to define.

Value Interval: Sets the elevation increment for subsequent zones.

Set Colors: Enables the Starting Color and Color Increment fields.

Starting Color: Sets the starting color number based on the standard CAD color chart.

Color Increment: Sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern: Sets the hatch pattern for the defined zones.

Set Scale: Enables the Scale option.

Scale: Sets the scale for the selected hatch pattern.

Clear: Clears all of the Elevation fields in the dialog.
Load: Loads previous settings from a saved .pat file.

Save: Saves the current setting configuration to a .pat file.

Label Contours: When enabled, contours will be labeled based on the settings below. If this option is disabled and further contour annotation is desired, utilize the Contour Elevation Label command.

Label Layer: Specify the layer name for intermediate contour labels. To only label index contours, enable the Label Index Contours Only option.

Index Label Layer: Specify the layer name for index contour labels.

Label Style: Specify the text style that will be used for the contour label text.

Label Integers controls how many digits to label to the left of the decimal. For example, if all contours are in the 5000's, then setting for three digits would label the 5280 contour as 280.

Label Decimals: Specify the amount of precision to display on the contour labels.

Label Text Size Scaler: Specify a relative text size scale factor to be applied to the label(s).

Use Commas adds a comma into the labels for the thousands place such as "5,000" instead of "5000".

Min Length to Label: Specify the desired minimum length of contours that should be annotated. In other words, Contours whose length is less than the value will not be labeled.

Positive/Negative Contour Prefix: Indicate a desired string of prefix text (e.g. Elev= ) that is to precede the positive and/or negative contour elevations, respectively.

Positive/Negative Contour Suffix: Indicate a desired string of suffix text that is to follow the positive and/or negative contour elevations, respectively.

Break Contours at Label: When enabled, the contour lines will be broken and trimmed at the label location for label visibility. As an alternative to physically placing a gap into the contour, consider using the Hide Drawing Under Labels option.
**Break Buffer Offset:** Specify the offset distance which determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

**Draw Box Around Text:** When enabled, a rectangle is drawn around the contour elevation labels.

**Box Buffer Offset:** Specify the offset distance which determines the gap between the box and the beginning or ending of the text.

**Label At Centerline Offset:** When creating contours and subsequent plan sheets for roads, enable this option to position the labels at a fixed offset from a centerline. The program automatically uses any polylines in the drawing that are tagged as centerlines. To check whether a polyline is a centerline, use the Centerline ID command. To create a centerline polyline from a centerline file, use the Draw Centerline File command.

**Draw Broken Segments:** When enabled, the segments of contours that have been broken out for label visibility will be redrawn as independent segments. To join these segments back into the contour, use the Join Nearest command.

**Layer:** Specify the layer that is to receive the newly drawn broken segments.

**Label Contour Ends:** When enabled, the ends of "open" contours will be labeled.

**Label Index Contours Only:** When enabled, only the index contours are labeled. This option is active only when Draw Index Contours has been selected in the Contour tab.

**Hide Drawing Under Labels:** When enabled, a "Wipeout" entity is placed with the annotation label that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

**Align Text with Contour:** When enabled, the contour elevation labels will be rotated to align with their respective contour lines.

**Use MText:** When enabled, contour labels are created using the MText entity type. Otherwise, the standard DText entity type is used.

**Draw On Real Z Axis:** When enabled, the contour labels are placed at the same "Z" (elevation) value of the contour itself. When disabled, the contour labels are placed at a "Z" (elevation) value of 0 (zero).

**Align Facing Uphill:** When enabled, the contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be placed in such a manner that the top of the text label will always be toward the uphill side of the contour.

**Internal Label Intervals:** Indicate the desired method for contour labels within the contour itself:

- **Label Intervals:** This option will label each contour with a set number of labels.
- **Distance Interval:** This option allows you to specify an interval distance between labels.
**Filter Selection By Inclusion/Exclusion Areas:** This option filters out selected entities from the triangulation that are outside the surface area defined by the inclusion/exclusion perimeter polylines. Otherwise, all the selected entities are used for triangulation and then the triangulation is trimmed at the inclusion/exclusion perimeters. Whether to prompt for inclusion/exclusion perimeters is specified on the Triangulate Tab.

**Specify Selection Options:** When enabled, indicate the type(s) of entities that are to be used during the triangulation process. This is an excellent method of "filtering out" unwanted entity types or enabling the use of desired entity types.

- **CAD Points, Lines, 2D Polylines, 3D Polylines, 3DFaces, Elevation Text and Inserts (blocks)** are standard CAD entities types.
- **Carlson Point Inserts** refer to Carlson points (such as those placed with the Draw Field to Finish command or which utilize the Carlson "SRVPNO*" family of blocks with point number, elevation, and description attributes).
- **Spot/Bottom Elevation Inserts** include text entities that start with 'X'.

**From File:** When enabled, allows you to triangulate from the points in an external coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source.

An *Error Log* is generated if the triangulation routine finds vertical conflicts between breaklines or other surface entities and displays the conflicts in a "docked dialog box." Three types of conflicts are reported (each conflict type is listed into its own category):

1. **Crossing Breaklines** - Indicates the common X,Y location of two breaklines that do not share a common "Z" elevation.
2. **Vertical Edges** - Indicates that two entities or vertexes of differing elevations have the same x-y location, thus forming a vertical plane to another point.
3. **Breakline T-Intersections** - Indicates that a third entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection.

Click the "+" sign beside a category to display the individual conflicts within that category and click the "-" sign to collapse the list. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect...
the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.

**Zoom To:** Centers the display on the location of the error without affecting the zoom resolution.

**Zoom In:** Increases the ability to see detail.

**Zoom Out:** Decreases the ability to see detail.

**Report One/All:** This option toggles between "One" and "All" depending whether a single line item conflict or an entire category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.

**Draw One/All:** This option toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict.

**Settings:** Indicate the desired configuration settings for the error log:
**Tolerances:** Indicate the lowest elevation difference threshold that should be reported for Crossing Breaklines, Vertical Edges and Breakline T-Intersections, respectively.

**Layer Name:** Specify the layer name for the "X" entities drawn with Draw One/All option. This also sets the layer name for the Draw Lines option.

In the case of crossing polylines, Draw Lines will trace over the polylines responsible for the conflict.

**Symbol Size:** Specify the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

**Note:**

- When selecting Inclusion/Exclusion polylines, you may select any number of Inclusion polylines and any number of Exclusion polylines. Selecting multiple Inclusion polylines results in "islands" of terrain data within a given TIN file.
- If Triangulate & Contour reports zero points found and fails to do anything when you're using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable Triangulate & Contour to read the elevation from the elevation attribute of the point.
- For those experienced in programming, Carlson offers a DTM API (Application Programming Interface) which provides functions that can be used to access and manipulate information stored within a DTM file.
- In surface situations where a series of rectangular grid cells are desired, explore the Make 3D Grid File command.

**Prompts**

The following are the most often encountered prompts:

**Select the Inclusion perimeter polylines or ENTER for none.**
*Select entities:* Select the desired closed polylines that form the bounding inclusion area(s) of the surface model and press Enter when complete.

**Select the Exclusion perimeter polylines or ENTER for none.**
*Select entities:* Select the desired closed polylines that form the regions(s) of the surface model where triangulation should not occur and press Enter when complete.

**Select the points and breaklines to Triangulate.**
*Select entities:* Select the desired entities from CAD using standard CAD selection methods and press Enter when complete.

**Pulldown Menu Location(s):** Surface (Survey, Civil, Hydro, Construction, Field, Natural Regrade), Takeoff > Surface Tools

**Keyboard Command:** tri

**Prerequisite:** "Triangulate-able" entities in the drawing (defined by the Selection Tab) and/or an external point file.
Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

Load TIN File: Allows you to specify a triangulation (.flt or .tin) file to load.

Load DXF File: Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

Select 3D Faces: Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

Pick Bounding Polylines: Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

Fast TIN Intersect: When checked, this command will perform a simple and fast check for overlapping triangles, so is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked, so that a complete and thorough check and repair of the TIN is performed.

Fill-in-holes: When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

Region Mode: This option deals with nested or overlapping boundaries. When checked, AutoCAD hatch pattern logic is applied, in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

Next: Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired operation/s will be performed on the entire TIN.
Add Value: Prompts for a value to Add to the subject area of the TIN.

Subtract Value: Prompts for a value to Subtract from the subject area of the TIN.

Multiply Value: Prompts for a value to Multiply to the subject area of the TIN.

Divide Value: Prompts for a value to Divide to the subject area of the TIN.
**Add TIN:** Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

**Subtract TIN:** Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

**Min TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

**Max TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

**Merge TIN:** Merges the current subject TIN into a second user-specified TIN file. There are three methods:

- **Current TIN inside/Second TIN outside boundary:** This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. The current TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN.

- **Second TIN inside/Current TIN outside boundary:** This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines where selected in the initial dialog. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN.

- **Wipe, combine and repair Current TIN where overlaps Second TIN:** This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don't have matching have elevations on their common boundary. Then this method will create a transition zone between the TINs.

**Enhance Flats:** This routine eliminates flat triangles by adding a data point inside the triangle at a different elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.

**Offset:** Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount. The routine offsets each point in the tin vertically by looking at the slopes that connect to the point. For points at slope transition points such as at the bottom of a ditch, these corner points are effected by both slopes which means the program can't hold either exactly. To hold both slopes exactly would require changing the x/y position of the tin points which this routine doesn't do to avoid more complications. So if the offset surface needs to exactly hold the slopes, then use another method like drawing cross sections for the surface, offsetting these sections, creating 3d polylines from the sections and modeling the 3d polylines.

**Simplify:** Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh. There are two methods. Elevation Difference looks at the effect of removing a point from the Tin. The point is removed if the elevation difference between the original point and the updated Tin is less than the tolerance. The Edge Cost method looks at the effect of removing an edge from the Tin.
**Tolerance**: This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Passes**: For elevation difference, this is the number of times the program will check through all the points.

**Hold Breaklines**: Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Breakline Weight** factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Breakline Weight** factor, so the greater the **Breakline Weight** factor, the fewer vertices that are removed, the lower the **Breakline Weight** factor, the more vertices that are removed.

TIN Statistics: Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z value.

**Subdivide**: Subdivides triangles to make them more equilateral.

**Set New Elev**: Sets all TIN faces in the subject area to the elevation specified.

**Set NULLs to Elev**: Sets all NULL values in the subject area to the elevation specified.

**Set Elev to NULL**: Sets all of the elevation values in the subject area to NULL.

**Set Elev by Surface**: Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

**Output Options**: The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be toggled on.

- **Insides**: If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border**: When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides**: If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.
**Save As TIN:** Saves the current TIN as an .flt or .tin file.

**Save As DXF:** Saves the current TIN as a .dx file. This format can be used by many other CAD programs.

**Draw As 3DFaces:** Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.

Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.

Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis.

Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.

Toggles shading on and off. Restores the graphics to plan view. Reverses the effects of all operations performed on the TIN and reverts it back to its original status. This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** TINUTIL  
**Prerequisite:** 3D Faces, a TIN file or a DXF file.

**Surface Manager**

The **Surface Manager** toolkit allows the user to modify pre-defined triangulated surfaces, making real-time modifications and updates to contours and associated TIN (Triangulated Irregular Network) definitions. Functionality includes swapping TIN lines, adding breaklines to the surface, adding or removing points, adjusting point elevations, removing TIN lines, drawing or removing contour lines and labels, re-contouring at a different interval or with different label settings, etc. Contour lines are automatically updated to reflect any changes made to the TIN. A surface must be named and saved by one of the surface modeling routines (in the Triangulate tab) as a prerequisite to using the **Surface Manager** tools.

![Surface Manager](image)

All of the tools available in the **Surface Manager** are also available in the **Surface>>Triangulation Surface Manager** fly-out menu, as shown in this figure. Their functions are identical but require a surface to be set current. Changes made apply only to the current surface.
The Surface Manager dialog box contains the following options:

**Set Current** designates a surface as current for editing with various surface tool functions, such as modifying TIN lines, setting a new contour interval, labeling contours, etc.

**Add** allows you to add a surface by selecting a surface model file (.TIN or .FLT).

**Remove** allows you to remove a surface from the list of stored surfaces.

**Rename** allows you to rename a surface.

**Copy** creates a copy of the TIN file and adds the copy as a new entry.

**Edit** allows you to perform various TIN-related modifications to the current surface. Using the **Edit** function will activate the command line, where the user will be prompted with the following options:

**Add Point** (AP) adds a triangulation point to the network by picking a point from the screen. The pick must be inside an existing triangle. The elevation for the selected point is interpolated from the surrounding TIN network. This is a good method for adding additional triangulation to the surface in a sparse area. Also, a new elevation can be specified for the picked point. This function does not create Carlson points, and the point will not be saved to the .CRD file.

**Remove Point** (RP) removes an existing triangulation intersection from the TIN network. The affected triangulation re-adjusts to compensate for the missing intersection. Contours update accordingly.

**Move Point** (MP) is a combination of removing a point and adding it at a new location.

**Add Breakline** (AB) adds a breakline to the surface by picking beginning and ending points on the screen. The endpoint snap automatically turns on. Only one breakline can be created at a time. The TIN network will reconfigure to follow the new breakline and update the contours. This does not create 3d polylines in the drawing.

**Add Entities** (AE) adds a number of points and breaklines into the selection set by selection of existing entities into the current surface.

**Swap Edge** edges (SW) swaps common TIN edges to create two different triangles from the original triangle configuration. Contours automatically update to reflect changes made to the TIN. Some common edges may not be swapped because of the orientation of the two triangles.

**Set Elevation** (SP) Sets a new elevation for a specified TIN intersection. The affected TIN is adjusted and the contours are updated.

**Remove Tri** (RT) removes a TIN line from the surface by picking a TIN line or selecting an interior point. Contours are removed from the affected area.

**Hide Tris** (ST) turns the TIN network on and off.
Point addition/removal and elevation-related changes made to the TIN are only reflected in the surface file and the contours resulting from that surface file. Point changes are not saved to the .CRD file and 3D linework is not updated in the drawing. Use traditional methods to update these entities if desired.

**Prompts**

The command line will prompt as follows:

**Add Pnt(AP),Remove Pnt(RP),Move Pnt(MP),Set elev(SP),Add Breakline(AB), Add Entities(AE), SWap edge(SW),Remove Tri(RT),Show/Hide Tris(ST), Press Enter when done.**

**Adding points, Pick point or enter keyword:** Type in the two letters of the function to be performed and press enter.

Add Points

**Add Pnt(AP),Remove Pnt(RP),Move Pnt(MP),Set elev(SP),Add Breakline(AB), Add Entities(AE), SWap edge(SW),Remove Tri(RT),Show/Hide Tris(ST), Press Enter when done.**

**Adding points, Pick point or enter keyword:** Press Enter to accept the default mode of Adding Points. Pick a point inside the TIN model at the desires location. The default elevation will be interpolated from the TIN model.

**Enter the elevation of new point [559.112171]: 560**

The surface will be recalculated using the input data.

Remove Points

**Add Pnt(AP),Remove Pnt(RP),Move Pnt(MP),Set elev(SP),Add Breakline(AB), Add Entities(AE), SWap edge(SW),Remove Tri(RT),Show/Hide Tris(ST), Press Enter when done.**

**Adding points, Pick point or enter keyword:** RP Pick close to the area that you want an elevation point removed.

Add Breakline

**Add Pnt(AP),Remove Pnt(RP),Move Pnt(MP),Set elev(SP),Add Breakline(AB), Add Entities(AE), SWap edge(SW),Remove Tri(RT),Show/Hide Tris(ST), Press Enter when done.**

**Adding points, Pick point or enter keyword:** AB

Pick near the 1st point of breakline: Pick a point
Pick near the 2nd point of breakline: *Pick a point* When adding a breakline, OSNAP Endpoint will default on.

Swap Triangle Edge

Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB), Add Entities(AE), Swap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.

Adding points, Pick point or enter keyword: *SW*

Please select an internal edge to swap: Select desired edge.
Set Point Elevation
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), Swap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.
Adding points, Pick point or enter keyword: SP
Pick near the point to have elevation set: Pick near point 34.
Enter new elevation of the point [597.200000]: 600

Remove TRI Line
Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),
Add Entities(AE), Swap edge(SW), Remove Tri(RT), Show/Hide Tris(ST), Press Enter when done.
Adding points, Pick point or enter keyword: RT
**Remove TRI Fence**
Removes all triangles crossed by the fence chain

**Add Pnt(AP), Remove Pnt(RP), Move Pnt(MP), Set elev(SP), Add Breakline(AB),**
**Add Entities(AE), SWap edge(SW), Remove Tri(RT), Remove Tri by Fence (RF), Show/Hide Tris(ST), Press Enter when done.**

**Adding points, Pick point or enter keyword: RF**
Pick beginning of fence:
Pick next point of fence or press Enter to finish:
Pick next point of fence or press Enter to finish:
Pick next point of fence or press Enter to finish:

To conclude the Surface Edit mode, *press Enter* at the end of the internal command sequence. This will return to the Surface Manager dialog. If user presses Escape key instead, the following dialog is displayed:

this prevents accidental data loss in case of unintentional use of Esc key.

**Properties** allows the user to alter the drawing display properties for TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. For instance, if Draw Triangulation Lines was checked on, unchecking the box and pressing ok will redraw the surface without the TIN lines. If the contours were drawn at 1 foot intervals, setting the interval value to 2 and pressing OK will redraw the contours at 2 foot intervals. Refer to the *Triangulate and Contour* section of the manual for a more detailed explanation of the options below.
Done

Done exits the Surface Manager and saves any modifications performed to the surface/s updating the .flt or .tin file.

Pulldown Menu Location: Surface >> Triangulation Surface Manager

Keyboard Command: surface_mg

Prerequisite: A triangulated (non-grid) surface

Contour from Triangular Mesh

This command creates contours directly from displayed Triangulated Irregular Network (TIN) surface features (triangles), optionally creating a external Triangulation File (.TIN) in the process. The user is prompted to pick a sample of the TIN to process. This will automatically filter out all other entities that don't reside on the layer of the displayed TIN faces. The triangles must be drawn on the screen as 3D Lines or 3D Faces. All of the settings for Triangulation, Contouring and Labeling, found in Triangulate and Contour are available. See the Triangulate and Contour section in the manual for a detailed description of each of these settings.

It is not recommended to use the "Subdivisional Surfaces" option in the Contour tab when using this routine. Use of this option with this routine may allow the internal reconfiguration of triangles that have been formed along breaklines.

Prompts

Triangulate and Contour From TIN Lines dialog box
Determining layer name for triangulation lines.
Select sample of triangulation line: *pick a mesh line and press Enter*
Select all the triangulation lines to contour.
Select objects: *select the triangulation entities*
Reading points... 82
Contouring elevation 404
Inserted 1195 contour vertices.
The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

**Pulldown Menu Location:** Surface >> Contour from...
**Keyboard Command:** contour
**Prerequisite:** A triangulated irregular network drawn as lines or triangular 3D Faces.

### Contours from Grid File
This command creates contours from a surface model defined by a grid file. Contouring from a grid employs a different method than from a triangulation network and generally produces contours that loop more. The grid has data points at a regular interval while the triangulation has edges for every point and breakline in the surface. The smoothness of the contours depends a great deal upon the grid resolution.

**Hatch Zones** will fill the intervening spaces between specified elevation ranges with hatch patterns or solid color fills.

**Create Polyline Topology** will create closed polylines for each contour range and will draw a zone text label within each area. This polyline topology can be used in GIS routines such as *Polygon Processor*.

**Smooth Contours Setup:** The Low to High slider bar controls the amount of smoothing. This smoothing method is based on the Bezier method. The **Apply Outlier Reduction Filter** option will remove spikes in the contour polylines that don't follow the general trend of the contour. The **Reduce Before Smoothing** option applies the Reduce Vertices function on the contour polylines before applying the Bezier smoothing. By reducing before
smoothing, the contours will have more freedom to smooth since the Bezier method holds all original polyline vertices and the reduce will result in fewer vertices to hold. The **Offset Distance** is the maximum distance the contour is allowed to shift when removing vertices during reduce. **Smoothing Sub-Division** will internally subdivide the grid cells with a quadratic smoothing algorithm to help create smoother contours.

**Prompts**

**Select the Inclusion perimeter polylines or ENTER for none.**
Select objects: *pick a closed polyline for the contour boundary if any*

**Select the Exclusion perimeter polylines or ENTER for none.**
Select objects: *pick a closed polyline for the area to exclude*

**Grid File to Process dialog** select a .grd file

**Contour from Grid File options dialog**

**Extrapolate grid to full grid size (Yes/No)? press Enter** This prompt appears if your grid extends beyond the limits of your data points in some areas.

![Contour from Grid File dialog](image1)

![Contour Smoothing Options dialog](image2)
Contours interpolated from GRID

Setting color ranges using "Hatch Zones" option
**Pulldown Menu Location:** Surface >> Contour from...

**Keyboard Command:** cntrgrd

**Prerequisite:** A grid file

---

**Contour from TIN File**

This command creates contours directly from a TIN file (.flt or .tin) without the need to have the TIN drawn on the screen. The routine starts by opening the dialog for *Triangulate and Contour*, allowing the user to specify triangulation, contour and label settings. After pressing *OK* on the initial dialog, a second dialog opens, allowing for the selection of the TIN file from which to create the contours.

See the *Triangulate and Contour* section in the manual for a detailed description of each of the settings.

---

**Prompts**
Fill out the Triangulate and Contour Dialog information with the desired options.
Select the desired TIN file and choose Open.

**Loading edges...**
- Loaded 1994 points and 5944 edges
- Created 3936 triangles
- Removed 9 disconnected edges.

**Reading points... 0**

**Contouring elevation 497**

**Inserted 1926 contour vertices.**

The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

**Pulldown Menu Location:** Surface >> Contour from...

**Keyboard Command:** cntrTIN

**Prerequisite:** A TIN file (.flt or .tin)

---

### Contour From Section File

This command creates contours from an existing cross section file. Both a section file (.sct) and a centerline file (.cl) are required to generate contours. All of the settings for Triangulation, Contouring and Labeling, found in *Triangulate and Contour* are available.

See the *Triangulate and Contour* section in the manual for a detailed description of each of the settings.

### Prompts

#### Triangulate and Contour dialog box

![Triangulate and Contour Dialog](image)

After pressing **OK**, the user will be prompted to select an existing section file (.sct) and a centerline file (.cl).
Reading points... 314
Inserted 314 points
Inserted 518 breakline segments
Contouring elevation 2016
Inserted 3091 contour vertices.
The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

Pulldown Menu Location: Surface >> Contour from...
Keyboard Command: cntr_sct
Prerequisite: A section file (.sct) and a centerline file (.cl).

Smooth Contours
This command has options for applying smoothing to polylines. Select the radio button for the smoothing option you want to apply. If you use Quadratic B-Spline type smoothing or Cubic B-Spline type smoothing, the Spline Segments AutoCAD system variable is relevant. The Curve Fit option provides the least smoothing, and the Cubic B-Spline option applies the most. Another effective way of smoothing is by creating the contours from rectangular meshes using various grid resolutions. Increase the smoothing by lowering the grid resolution and decrease by raising the grid resolution. The Bezier option provides an incremental type of smoothing. The Linetype Generation option turns on the Ltype Gen flag for the selected polylines. For more information on this option and the spline smoothing options, look up the PEDIT command in the AutoCAD Reference Manual. After selecting the OK button the routine will prompt for needed values.

Bezier smoothing is also embedded in many of the routines that create contours. Bezier smoothing applies the Bezier smoothing algorithm to polylines. This smoothing technique has two advantages over Spline or Curve Fit smoothing. One is that a Bezier smoothed polyline will pass through all of the vertices in the original polyline, while a Spline smoothed polyline only curves towards the original vertices and can pull away from vertices at sharp corners. Hitting all the original vertices can be an important feature in contour maps for maintaining the exact location of the contours. Another benefit of Bezier smoothing is the ability to control the looping and vertex factors. A higher looping factor increases the curving effect. Use this setting with some care, as too high a looping factor may cause nearby contour lines to cross after the smoothing has been applied.

Vertex reduction can also be applied along with the smoothing. This avoids having to create smoothed polylines with numerous vertices and then having to reduce these vertices in a second step. Be sure not to make the cutoff offset for reduction too high or you can negate or even reverse the smoothing effect. One disadvantage to Bezier smoothing is that it cannot be decurved like the other smoothing techniques.
Prompts

Enter the looping factor (1-10) <5>: press Enter This determines the extent of curving. 1- least curvy, 10 - most curvy.

Enter the offset cutoff <0.05>: press Enter This value is the maximum shift distance for vertices reduction. A higher value removes more vertices.

Select polylines to smooth.
Select objects: pick polylines

Before Smoothing

After Smoothing
Reduce Contour Vertices

Contouring and smoothing often creates an explosion in file size due to the many vertices it adds to the individual contour polylines. Fortunately, many of these vertices are very close together, some of which can be removed with no visible effect on the contour polylines themselves. *Reduce Contours Vertices* can reduce the total number of vertices up to 90%. This has the benefits of a smaller drawing file, faster drawing loading, and faster regens.

This command removes vertices in a polyline that are within a user specified offset cutoff. The algorithm looks at three vertices at a time, and calculates the distance between the second point and the line from the first to the third point. If this distance is less than the user specified cutoff, the second point is removed. In theory, reducing the polyline vertices should not shift the polyline more than the user's cutoff distance. The default for this cutoff is one tenth of a foot. Increasing the cutoff will remove more vertices while decreasing it will more closely preserve the original contour line. When combining vertex reduction with smoothing, it is suggested to smooth before reducing, although it can be done the other way around.

**Prompts**

Enter the offset cutoff <0.1>: .3
Select polylines to reduce. *select polylines*
Select objects: *press Enter* to conclude selection
Processed polylines: 1
Total number of vertices: 1125
Number of vertices removed: 939

*Before Vertex Reduction*
After Vertex Reduction

Pulldown Menu Location: Surface >> Modify Contours  
Keyboard Command: reduce  
Prerequisite: Polylines (contours) with vertices to reduce

Edit Contours
This command revises a segment of a contour polyline. Begin by picking a point on the contour where you want to start editing. Then pick new points for the polyline. When finished picking new points, press Enter and then pick a point on the contour to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

If there is a triangulation file associated with the contours, then the command prompts for whether to update the triangulation surface file to match the contour edits. When this option is used, data points are added to the triangulation surface along the edited contour segment to make the triangulation surface match the contour line. Existing triangulation source data is retained. So the updated triangulation is the combination of the original source data and the additional points from Edit Contours. One way to get a triangulation surface associated with the contours is to use the Triangulate & Contour command with both Write Triangulation File and Draw Contours options active.

Note: If the triangulation association is not used, then this routine has no effect on the actual triangulation or grid surface model file that the contours may have been drawn from. It only revises the drawn contour or polyline on the screen. If the contours are later regenerated from this file, the edits will be discarded.

Prompts
Select contour to edit: pick the contour polyline at the place to start editing  
Pick intermediate point (Enter to End): pick a point  
Pick intermediate point ('U' to Undo, Enter to End): pick a point  
Pick intermediate point ('U' to Undo, Enter to End): press Enter  
Pick reconnection point on contour: pick the contour polyline at the place to join
Contour ID
Contour ID reports the routine and source data used to generate the selected contour polyline.

Prompts

Select contour polyline to identify: pick a polyline
Surface Name: Triangulate & Contour by screen entities
Select contour polyline to identify (Enter to end): press Enter

Color Contours by Elevation
This command sets the color of the selected contour polylines and text based on elevation. The color to use is defined in elevation range table.
• **Auto** - This button opens the following dialog, allowing for automatic configuration of the range of elevations and colors.

  ![AutoCAD dialog](image)

  - **Starting Zone #** - Sets the zone with which to begin the application of the settings defined in this dialog. For instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.
  - **Set Values** - Enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.
  - **Starting Value** - Sets the starting elevation value for the first zone.
  - **Value Interval** - Sets the elevation increment for subsequent zones.
  - **Set Colors** - Enables the Starting Color and Color Increment fields.
  - **Starting Color #** - Sets the starting color number, based on the AutoCAD standard color chart.
  - **Color Increment** - Sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.
  - **Note**: The Pattern, Scale, and Layer options do not apply to this command.

• **Clear** - Clears the all of the Elevation fields in the dialog

• **Load** - Loads previous settings from a saved .pat file

• **Save** - Saves the current setting configuration to a .pat file.
Prompts

Select polylines and text to color: *pick the entities*
Define Ranges Dialog
Pick point for color legend: *pick a point to a clear area of the drawing to place a legend or press Enter for no legend*

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours
Keyboard Command: ctrcolor
Prerequisite: Contours polylines

Color Contours by Interval

This command sets the color of the selected contour polylines based on the elevation interval values, which are essentially the number that the elevation ends with, so specific colors are assigned for elevations ending in 0, 1, 2, etc. The color assignments are defined in the Define Interval Colors dialog box.

Select Entities: User is prompted to select the contour polylines to change.
By Layer: Contour polylines are selected automatically by their layer.

Prompts

Define Interval Colors Dialog If Select Entities is set as Interval Colors Method, *pick OK*, and you are prompted to:
Select polylines and text to color: *pick the entities* If By Layer is set as Interval Colors Method, set the layers by Screen selection or from a list by Name, then *pick OK.*

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours
Keyboard Command: ctrcolor2
Highlight Index Contours

This command will move contours of a specified interval to another layer. This allows the user to change the color or width of a certain interval. This is useful if all the contours had been generated on a single layer, and you wish to display the index contours differently based on a new layer setting.

Prompts

Layer name of existing contours <CTR>: press Enter
Layer name for highlight contours <NCTR>: press Enter
Select Contours to Highlight.
Select objects: Select contours using any standard selection methods.
Select objects: press Enter to conclude selection. The program then sorts and displays the High and Low interval of the selected contours.
Contour increment to highlight: 10
Starting Highlight at elevation <98.0>: 100
Ending Highlight at elevation <152.0>: 150
Assuming we had drawn 1 foot intervals, the above example would move the contours on elevations 100, 110, 120, 130, 140 and 150 to the layer NCTR.

Pulldown Menu Location: Surface >> Modify Contours
Keyboard Command: indexctr
Prerequisite: Contours should be plotted and visible on the screen.

Highlight Depression Contours

This command highlights depression contours by changing their layer, color, and adding tick marks. A depression contour is a closed contour line that leads to a local minimum such that there are no contour lines with a higher elevation within the contour. This routine finds the depression contours out of the selected polylines. The depression contours are highlighted, and the user selects which ones to label.

Prompts

Layer name of existing contours <CTR>: Enter
Layer name for depression contours <DCTR>: Enter
Width for depression contours <1.0>: Enter
Tick Interval for depression contours <50.00>: Enter
Tick Size for depression contours <6.0>: Enter
Select the existing contours.
Select objects: Select all the contour polylines, even the contours that aren't depression contours.
Select objects: press Enter to conclude selection. The program then sorts and displays the high and low elevations of the selected contours.
Reading the selection set ...
Locating the depression contours ...
Highlight all or selected depression contours [All/<Selected>]? A The "All" option changes all contours identified as depression contours to the specified layer and adds tick marks. The "Selected" option highlights all contours identified as depression contours and then user is prompted to select which ones to change to specified depression contour layer and add tick marks to.

Drawing the depression contours ...

Pulldown Menu Location: Surface >> Modify Contours
Highlighted depression contours

**Pulldown Menu Location:** Surface >> Modify Contours

**Keyboard Command:** depress

**Prerequisite:** Contours should be plotted and visible on the screen.

### Draw Contour Gradient Marks

This command draws lines perpendicular to contours to shown the downhill slope direction. In the options dialog, set the layer for the existing contour polylines, the layer for the new gradient lines, and the size scaler for the new lines which is relative to the current scale from Drawing Setup. Next, the program prompts for the surface triangulation file which should be the same surface that the contours represent. The program uses this surface file to determine the direction for the gradient lines. Then the program prompts for where to draw the gradient marks. The Polyline option draws marks at each intersection of the selected polyline with the contours. The Point method prompts for two points and draws marks at the contour intersections with the line defined by these two points.
Prompts

Options Dialog
Select Surface File
Define a line which slices the contours at the place to label them.
Pick 1st point (P-Polyline, Enter to end): pick point
Pick 2nd point: pick point
Define a line which slices the contours at the place to label them.
Pick 1st point (P-Polyline, Enter to end): press Enter

Pulldown Menu Location: Surface >> Modify Contours
Keyboard Command: ctr_grad
Prerequisite: contour polylines and surface file

Change Contour-Plines Width
This command allows the user to select a group of contours/plines and change their width for emphasis when plotting. Prior to running this command, the desired contours can be isolated to their own layer using the Highlight Index Contours command, or if already on a separate layer you may use Isolate Layer from the View menu.

An alternate to using this routine is to assign an AutoCAD lineweight to the layer that the contours or polylines are on and set the Display Lineweight toggle at the bottom of the screen. If using this routine to assign a polyline width, then this new width will display regardless of the lineweight toggle.

Pulldown Menu Location: Surface >> Modify Contours
Keyboard Command: cwidth
Prerequisite: Contour polylines should be drawn and visible on the screen.

Trim Contour-Plines by Pline
This command can be used to trim a group of contour lines or polyline entities that cross a perimeter defined by a 2D polyline. The trim can be executed on the inside or the outside of the perimeter.

Prompts

Warning: All of the trim perimeter should be visible on the screen!
Select polyline which represents perimeter: select trim perimeter
Pick point on the side of perimeter to trim from: pick a point To trim contours on the inside of the perimeter, pick a point on the inside of the perimeter (this is useful for deleting contour lines that fall inside a building or some area that you want void of contours). To trim contours on the outside of the perimeter, pick a point outside of the perimeter.
**Pulldown Menu Location:** Surface >> Modify Contours  
**Keyboard Command:** polytrim  
**Prerequisite:** Draw a 2D closed polyline perimeter.

### Contour Elevation Label

This command can be used to simultaneously create elevation labels on a group of contour polylines at elevation. First the command starts with a dialog with the label options. Then to place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. Alternatively, you can type P for Polyline at the Command prompt and select a polyline. Then the program finds all the intersections between the selected polyline and the contours and places labels at these intersections. The actual "z" elevation of the contour line determines the label value.

![Contour Label Options](image)

**Label Layer** specifies layer name for the contour labels that will be created.  
**Label Style** specifies the text style to be used for labels.
**Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels. **Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units.

**Integers** controls how many digits to label to the left of the decimal. For example, if all contours are in the 5000's, then setting for three digits would label the 5280 contour as 280. **Decimals** sets the decimal precision for the labels to be created. **Label Position** determines the label position in relation to the contour polyline.

- **On Contour** centers the label on the contour line.
- **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylines** enables the routine to filter out all entities with an elevation of zero. **Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label. **Align Facing Uphill** makes the label parallel to the contour and flips the label so that it reads facing uphill. Otherwise, the labels are made to face up relative to the current screen view. When this option is on, the program prompts for a triangulation surface file that should match the surface the contours represent.

**Use Commas** adds a comma into the labels for the thousands place such as "5,000" instead of "5000". When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility. When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle. **Label Contour Ends** creates labels off the ends of the contours. **Label By Distance** places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

- **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels. The Offset Scaler controls the size of the rectangle. The **Draw On Real Z Axis** chooses between creating the text entities at the elevations of the contours or at zero elevation. The **Use MText** chooses between creating MText and DText label entities. **Label Index Only:** When checked, only Index contours are labeled.

**Prompts**

**Contour Label Options Dialog Opens** Select the desired options and press OK. **Define a line which slices the contours at the desired label locations.**

**Pick 1st point (P-Polyline, Enter to end):** *pick a point*

**Pick 2nd point:** *pick a point*
By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** gclabel  
**Prerequisite:** polylines with elevation (contour polylines)

---

**Local Elevation Label**

This command allows the user to place elevation labels on contour lines or other entities with elevation. The command prompts for two points to align the rotation angle of the label, centers the label between the picks, and then prompts for two break points which are used to erase/break the contour that runs through the elevation label. If a break is not required just press [Enter] at the break point prompts.

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** clabel  
**Prerequisite:** polyline with elevation

---

**Move Label Along Contour**

This command slides an existing contour label along a contour, maintaining its alignment with the contour. After moving the label, you can type F for Flip at the Command prompt to rotate the label orientation by 180. The label must have originally been created with the *Break Contours at Label* option *Off*. If the option to *Hide Drawing Under Labels* was used when the label was created, the wipeout will move with the label when using this command.

In addition to moving a label, an existing label can be copied and placed at a new position along the contour by using the Copy option at the first prompt.

**Prompts**

*Copy/<Select contour label to move>:* Pick label  
*Pick new contour label position:* Move mouse to relocate label  
*Flip last/<Select contour label to move (Enter to end)>:* press Enter

**Pulldown Menu Location:** Surface >> Contour Labels
Flip Contour Labels-Text

This command individually rotates each of the selected text entities by 180 degrees.

Pulldown Menu Location: Surface >> Contour Labels
Keyboard Command: fliptext
Prerequisite: Text labels on contours

Tablet Calibrate

This command executes the routine to calibrate the digitizer tablet to a hardcopy drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Please refer to Configure, General Settings and Digitizer Puck Layout for selection of the correct puck layout before proceeding.

Tablet Calibration

**Known Reference Points** uses two known coordinates for reference points on the hardcopy drawing. When this option is selected, the fields for coordinate information activate. Enter the known northing and easting values for the reference points from the information on the hardcopy drawing in the appropriate fields and select the *Pick* button. Pick the points from the hardcopy drawing using the tablet. Carlson Civil saves the coordinates of the two reference points for future calibrations and displays them on the *Tablet Calibration Dialog* the next time it is accessed, so if you are working on the same drawing, you can use the *Known Reference Points* method with the saved coordinates to calibrate to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.

![Tablet Calibration Dialog](image)

**Drawing Scale with New Reference Points** is very convenient when you don't know the precise coordinates of the entities on your hardcopy drawing. You must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then select the *Pick* button and pick the point on the hardcopy drawing to assign the specified coordinate to.
The routine will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be displayed in the Tablet Calibration Dialog as Known Reference Points the next time you calibrate the tablet, so you can digitize the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitizer tablet.

Prompts

Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: pick a point
Pick second reference point: pick another point

Pulldown Menu Locations: Surface >> Digitize Contours
Keyboard Command: digsetup
Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, correctly configured, and have Wintab driver installed. Select the puck layout in Configure.

Digitize Contours (Polyline)

A contour is drawn as a polyline which consists of a series of connected points with a constant elevation. There are two ways to digitize contour lines: sketch mode or point mode. You can start digitizing a contour with one mode and switch to the other during digitizing the contour. Sketch mode uses more points than pick mode. In general, we recommend using pick mode to digitize the straight parts of lines because it reduces the number of points and speeds up calculations, but using sketch mode to digitize the curved parts because it is fast and accurate.

This command lets you digitize contours as polylines one at a time. The first time it prompts you with the Digitize Contours Dialog. Enter the layer name or select it from a list of existing layers. Look at your hardcopy plans and determine an elevation interval that is between most of the contours and enter it in the Elevation Interval field. You are able to modify both the value and the direction of the elevation interval between digitizing contour lines, using the buttons on the puck.
To have Carlson Civil automatically close contours whose beginning and ending points are within a specified range, check the **Auto Detect Close Contour**. **Draw Labels** will draw the elevation at the starting point of the contour. In Pick mode, if you want the program to automatically zoom the display to center around the last point when you get near the edge of the screen while picking points, check the **Auto Zoom Center**. Click **OK** to start digitizing.

If this is your first time digitizing a contour, you are defaulted to the Pick Mode digitizing, otherwise you will be defaulted to the previous digitizing mode. If you want to use the other digitizing mode, press 0 (the number "zero") on the puck or enter 0 from the keyboard. Place your cursor at one end of the contour line and begin digitizing the line. While digitizing a line, you can force a contour to close on itself by pressing A on the puck to end the contour and connect the last point to the first point, remove a mistake by pressing B on the puck, or switch to the other digitizing mode by pressing 0. During Sketch Mode digitizing, you can stop digitizing by pressing the **Pick** or **Enter** button on the puck, take some rest or make edits, and start sketching again. At the end of the contour line, press **Enter** on your puck or keyboard. The contour is completed, and the elevation for the next contour is automatically incremented. You will be asked to digitize the next contour. If you press A on the puck or enter Yes on the keyboard, you can digitize another contour, or press B on the puck or enter No on the keyboard to end digitizing contours.

To digitize with a mouse instead of a digitizing tablet, go to the **Settings** menu, **Configure**, and **General Settings**. In the General Settings dialog box, under Digitizer Settings, clear the check box for **Auto Tablet On For Digitize Commands**.

![Digitizer Settings](image)

This is the Digitize Contours dialog box.

![Digitize Contours](image)

**Prompts**

**Digitize Contours Dialog**
Enter Layer Name, Elevation Interval, and toggle on/off Auto Detect Close Contour etc.

**Increment(1.00)(A)/Direction(+)(B)/Elevation <573.00>:** 450 Enter elevation or press Enter to accept current value.

**Start Digitizing...**
**Sketch(0)/Pick the first point:** pick a point to start Pick Mode digitizing Press 0 to switch to Sketch Mode.
**Sketch(0)/Close(A)/Undo(B)/Pick next point (Enter to end):** pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): 0 Press 0 on the puck or enter 0 on the keyboard to use Sketch Mode.

Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B Undo the last point.
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B Undo the last point.
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag again
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): 0 Press 0 on the puck or enter 0 on the keyboard to use Pick Mode.

Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): press Enter to finish digitizing

Digitize Another Contour [ <Yes(A)>/No(B)]? B Press B to finish digitizing.

Pulldown Menu Location: Surface >> Digitize Contours
Keyboard Command: digcont
Prerequisite: Calibrate the tablet with the Tablet Calibrate menu option if contours are to be taken off an existing hardcopy drawing.

### Make 3D Grid File

This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.

Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.

Grid superimposed over triangulated features

The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.
The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Source Data**: This option selects the type of data to use for gridding. The Screen Entities option processes selected 3D entities from the drawing including points, lines, polylines, 3D faces and inserts. The Coordinate File and Text File options read point data from the selected file. These methods are useful for large datasets that would take extra memory and time to draw as points in the drawing. For the Text File, the program will prompt for the order of the fields and the delimiter. The Triangulation File option will interpolate the grid elevations from the selected triangulation surface.

- **Range of Elevations/Values to Process**: Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.

- **Modeling Method**: The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.

- **Triangulation Modes**: When using Triangulation and Polynomial methods, there are four triangulation modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.
  - **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise the Triangulation Only method is used.
  - **Triangulation Only** method builds a triangulation surface out of all the selected points, lines and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.
  - **Triangulation with Subdivision** method uses the subdivisional surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.
  - **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and polylines. The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped and any
selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.

- **Use Inclusion/Exclusion Areas:** This option will prompt for inclusion and/or exclusion perimeter polylines and will only assign grid cell elevations within these areas and leave the rest of the grid cells as Null.

- **Grid Resolution:** The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the "number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grids cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt *Extrapolate grid to full grid size?*. Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. *Grid File Utilities* can be used to apply and save extrapolation to a grid file. The *Plot 3D Grid* command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

- Line 1 is the lower left Y coordinate
- Line 2 is the lower left X coordinate
- Line 3 is the upper right Y coordinate
- Line 4 is the upper right X coordinate
- Line 5 is the X direction grid resolution
- Line 6 is the Y direction grid resolution

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter 'N' is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.
Griding from Contour Maps

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

Prompts

Grid File to Create File Selection Dialog
Enter a name for the grid file.
Use position from another file or pick grid position [<Pick>/File]?
Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid
Pick Upper Right grid corner <8366.88,4195.08>: pick a point
Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you to set the X and Y size for each grid cell.
Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Grid File Utilities

This command is used to modify and create grid files. The modifications can be done manually on a single grid, on multiple grids in a batch mode or saved and rerun using the grid macros. To modify manually, start by picking the Select Grid(s) button. There is an option to use inclusion and exclusion polylines to only modify the grid within/outside these perimeters. With this option active, the program will prompt for inclusion and exclusion polylines when a function is selected. Only grid cells inside the inclusion polylines will be modified. Grid cells inside the exclusion polylines will not be modified. If no inclusion and exclusion polylines are selected, then the entire grid will be modified. Each function is described below.

- **Max Value**: Compares a grid and a value and takes the Maximum value of either. This is a way to stop a grid from going negative, below zero.

- **Max Grids**: Compares a grid with another grid and takes the Maximum (higher) value of either.
• **Min Value**: Compares a grid and a value and takes the Minimum value of either. This is a good way to cap a grid off at a certain value so it never goes higher than the specified value.

• **Min Grids**: Compares a grid with another grid and takes the Minimum (lesser) value of either.

• **Less Value**: Asks for a value to compare and a value to assign and uses the following logic:

  If GridA < compare_value then GridA = assign_value, otherwise no change

• **Less Grids**: Asks for a grid to compare and a grid to assign and uses the following logic:

  If GridA < compare_GridB then GridA = GridC, otherwise no change

• **Greater Value**: Asks for a value to compare and a value to assign and uses the following logic:

  If GridA > compare_value then GridA = assign_value, otherwise no change

• **Greater Grids**: Asks for a grid to compare and a grid to assign and uses the following logic:

  If GridA > compare_GridB then GridA = GridC, otherwise no change

• **Add Value**: Adds an entered value to the grid values. (GridA + X)
• **Add Grid**: Adds one grid to another grid. (GridA + GridB)
• **Subtract Value**: Subtracts an entered value from the grid values. (GridA - X)
• **Subtract Grid**: Subtracts one grid from another grid. (GridA - GridB)
• **Multiply Value**: Multiplies the grid values by an entered value. (GridA * X)
• **Multiply Grid**: Multiplies the grid values by another grid. (GridA * GridB)
• **Divide Value**: Divides the grid values by an entered value. (GridA / X)
• **Divide Grid**: Divides the grid values by another grid. (GridA / GridB)
• **Power Value**: Raises the grid values to the specified power. (GridA squared, or Grid A to the 1.8 power)
• **Power Grid**: Raises the grid values to another grid for the "power". (GridA raised to GridB)
• **Change Units**: Scales the grid X/Y and/or Z values to switch units such as meters to feet.

• **Set Value**: assigns the grid elevations to the user-specified value. For example by using Set Value with the inclusion perimeter option, you could set the grid values to 0.0 within the inclusion polyline for a strata thickness grid. The four options are Value to Value which will set all values to one value, Null to Value, which will set all Nulls to one value, Null to Grid, which will set all Nulls to another specified grid and Value to Null, which will set all values to Null. Using inclusion and exclusion perimeters are usually required for this command.
• **Extrapolate:** can be used to assign values to all grid nodes by any of four methods. Global Trend finds the average slope and slope direction from the existing grid elevations and applies this slope to calculating the missing elevations. Average method calculates a grid elevation as the average of its nearest neighbors. Projected method extends the trend at the edge. Combined method uses both Average and Projected.

• **Change Position:** This lets you change the lower left and upper right corners of the grid file. For example, you can use this routine to localize a grid file if you have a large grid for the entire site but are currently working on a smaller area. If the new position covers area outside the original position, any grid cells in this area will be assigned a null value. Otherwise the program uses the original grid values for the new grid position.

• **Change Resolution:** This changes the grid resolution (number or dimensions of grid cells). The program uses the original grid values for calculating the grid values at the new resolution. Enter a new value for X and Y number of cells or dimensions of cells.

• **Match Dimensions:** Sets the grid position and resolution to match another grid file. The program will prompt for a grid file to get the position from. Certain commands require grids match position and resolution. Running this command will ensure grids will match.

• **Smooth Grid:** Smoothing applies a quadratic smoothing algorithm to the grid by using neighboring nodes to adjust each grid node. This routine can be used to refine a grid so that the contours from the Contour from Grid routine appear smoother. Typically this adjustment is relatively small. To get more smoothing, run the routine more times.

• **Plot Grid:** This runs the Draw 3D Grid command. It is documented elsewhere in the manual.

• **Export Grid:** There are several choices for export options: Carlson Coordinate File (CRD), ASCII text as XYZ, ASCII text as YXZ, DTM, Carlson Triangulation (TIN) and Esri (ASC). There are two options for the ASCII delimiter, either a comma or a space. There is an option to skip a number of rows and columns between the exported points. When exporting into the Carlson CRD file, the description for the points is set at the bottom.
Export to DTM writes the current grid file to a DTM format text file. The format of this file is the following:

DTM 1.0 Header Line
test.dtm Name of file
51 Number of cells in X direction
51 Number of cells in Y direction
79442.4697 Lower left grid corner Y coordinate
14899.0326 Lower left grid corner X coordinate
0.0 Lower left grid corner Z coordinate
11.5618 Dimension of cell in X direction
7.0639 Dimension of cell in Y direction
1581.2612 Grid cell values starting from lower left, moving from left to right
1580.8879
1580.3257
etc...

- **Merge Grids**: creates a grid file by merging together two existing grid files, grid1 and grid2. The current grid is grid1 and the program will prompt for a second grid. These two grids must overlap with the same location and resolution. The inclusion and exclusion perimeters apply to grid2 such that the merged grid will consist of grid2 cells within the inclusion perimeters and outside the exclusion perimeters and grid1 cells everywhere else. The result is stored in the current grid.

- **Import Grid**: There are several formats that may be imported.
  - Text File (ASCII): This function allows for various formats. The data can be comma or space separated or in fixed width columns.
  - Carlson Triangulation (TIN, FLT)
  - DEM (Digital Elevation Model) such as from the USGS (US Geological Survey)
  - Esri (ADF)
  - Minex (ASC, CSV)
  - Mintec
  - Surfer (GRD both ASCII and Binary)
  - Vulcan (ASC, CSV)
**Import from Text File (X, Y, Z)** creates a grid file from X Y Z data in any text file. There does not need to be a current grid file loaded since this routine will create a grid file. The text file should consist of one X Y Z coordinate per row with the first coordinate being the lower left grid corner and the last coordinate as the upper right grid corner. There are options for space or comma separated coordinates and for the order of the coordinates as either row (left to right) or column (bottom to top). The prompting will be as follows:
Separation type [<Space>/Comma/FixedWidth]?
Column number for X coordinate <1>:
Column number for Y coordinate <2>:
Column number for Z value <3>:

**Import from Triangulation** prompts user to select a tin or flt file and allows user to adjust grid position and resolution. The grid file is created with the same name in the same directory as selected tin/flt file.

**Import DEM/ESRI** prompts user to select a dem, adf or ASCII ESRI grid file to be imported. The ESRI grid files can be created from ArcMap using the Raster To ASCII tool. If the file format is recognized program reads and displays the information about source projection and allows user to define target projection for transforming the grid to local coordinate system. Skip every # rows/cols allows user to reduce the size of the imported grid file. The grid file is created with the same name in the same directory as selected dem file.
Import Mintec allows user to import Mintec GSM Model Dump as grd files. User is prompted to select GSM Model Dump (txt) file, which is then processed to determine minimum northing, easting (lower left corner), resolution and size of the grid. First three columns of the GSM model dump must represent the X, Y and SEAM LEVEL respectively, a base name for the grid files is specified along with name of the quality that each column represents. User can define up to 17 qualities. When the import button is pressed all the imported grids are created with the name "BASE NAME-SEAM LEVEL-BASE ITEM.grd" in the same directory as source dump file.
Import Surfer prompts to select a grd file from Surfer program and creates a grd file.

- **List Grid**: displays a list of the northing, easting and elevation of each grid corner. There is an option to include NULL values in the list. A grid node will have no value, or a NULL value, listed as None, if the grid node was outside the limits of the data during Make 3D Grid File.

- **Spreadsheet**: displays the grid elevations in a row and column spreadsheet that is in the same layout as the grid file. Grid elevations can be edited in this spreadsheet and saved upon exiting the spreadsheet.
• **Select Grid(s):** This is the first step to load a grid. Usually a grid needs to be loaded before running a function. If Batch Process Grids is turned on, then multiple grids may be selected while holding down the Shift or CTRL buttons.

• **Grid Info:** This function displays information about the grid file. It is a form of Grid Statistics. The items it displays are shown in the report below:

```
Grid Statistics
Grid: C:\Drawings\GF\GF_THK.grd

Lower left grid corner : 3266000.00, 635000.00
Upper right grid corner: 3296000.00, 670000.00
X grid resolution : 600, Y grid resolution : 700
X grid cell size : 50.00, Y grid cell size : 50.00
Number of samples from grid data = 421301

Average: 3.46, Standard deviation: 4.72
Minimum value: 0.00 at 3266000.00, 635000.00
Maximum value: 14.55 at 3282000.00, 642000.00
Average Slope : 0.00%, 0.00 degrees
Average Slope Azimuth: 0.00'

Method: Grid File Utilities
Set NULL to Value: 0.00
```

• **Macro Command Recorder:** If there is a grid function that is done over and over again, or for many different grids, then this Macro Recorder is an efficient way to perform Grid File Utilities on many files, for many functions.
The Macro Command Recorder allows you to store the grid modifications steps to a (.GFU) file. The macro can be recalled with the LOAD button to re-run the steps. The Record button will prompt for a macro file name to create. Then start choosing grid function buttons and each grid file function will be stored to this file. Each grid file in the script is represented as a variable name such as A or B or anything, such as COALTHK. The current grid file that is being modified is specified in the Current Variable edit box.

When recording a step that involves another grid file, there are three options for storing this grid into the script. Use Grid Variable will use the grid assigned to the Grid Variable Name. Prompt for Grid File Name will bring up a grid file selection dialog each time the macro is run. Store the Grid File Name will save the specific grid file name into the macro.

To start the recording process, choose Record. Then go through the functions. Each will appear in the macro window. When done recording, choose Stop. The Append will add on to the end of an existing GFU file. Load will recall a save GFU file. Run will execute the Macro, and Edit will bring the text editor up for editing the GFU file. If Copy, Paste, Search and Replace are useful tools here. Sometimes it helps to record a function once, then copy and paste it many times while using the Search and Replace function to change grid file names etc. Additional explanation of the proper syntax is shown below in the GFU Macro File Details section.

- **Auto Extrapolate On Load:** This will extrapolate values for any null or empty values in the grid as the grid is loaded.
- **Use Inclusion/Exclusion Areas:** If this is turned on, then the GFU function will only be applied within the selected inclusion polyline and outside the selected exclusion polyline.
**Batch Process Grids:** When this option is turned on, GFU functions can be executed on many grids at once. It is recommended to move the grids to a backup directory, or create a copy of them, as the grids are over-written with the same name. The functions that cannot be batched are: Plot Grid, Merge Grid, List Grid, Export Grid, Import Grid and Spreadsheet.

**GFU Macro File Details**

The Surface Macro Launcher displays the GFU in the upper left window. This is an editor, and you can use basic functions like CTRL-X, CTRL-C & CTRL-V for cut, copy & paste. If there are any errors in the GFU during its execution, they will be displayed in the error log section. The Values Drilldown is a good way to do error checking on the macro. Use the Pick button to select a spot in plan view to fill in the Northing and Easting boxes. Then when the GFU is executed, the results of each line will be displayed. The Verbose Output will show the value of each line L1, L2, etc., instead of overwriting the variable each time it is encountered. GFU files also can be edited easily in any text editor, such as Notepad, WordPad or K-Edit.

**Variables**

Variables in the GFU can be any keywords providing meaningful identification of the data loaded. A variable can be either just a value or constant; or most commonly a surface (Grid or TIN). Individual macro lines typically have one of the following forms:

```
Variable1=Variable2
Variable1=Expression
Variable1=Function(Expression1,Expression2)
```

Whenever a new variable name is encountered on the left side of the equation, the new variable will be created. The program will use its knowledge of the right side of equation to define a type of the new variable. For example:

- A=1.0 Variable A will be just a value
- A=LoadFrom(abc.grd) Variable A is a grid loaded from file
- B=A Variable B is same variable type as A
- B=(1+C+A)/D Variable B will be 1+C+A, all divided by D. C and D will need to be defined somewhere before this line in the GFU.

**Important!:** Once a variable is defined, its type (like grid location and resolution) does not change. There-
fore, for the existing variable A, the following expression:

\[ A = \text{Min}(B, C) \]

is interpreted in the following way: for every point of the existing surface A calculate values of surface B and C and use the smaller of the two values to set new value of point elevation on surface A.

The following operators may be used in the expressions:

+ , -, *, / - regular arithmetic operators

<, >, =, ! (not) - logic operators

— (or), & (and) - binary operators

**Changing the scope of the equation**

The scope of any line of the script can be modified by adding one of the following inclusion/exclusion operators:

\[ A = \text{Min}(B, C); \text{INCLU}() \] - will prompt for inclusion at run-time

\[ A = \text{Min}(B, C); \text{INCLU}('\text{handle\_here}') \] - will use AutoCAD entity with specified handle for the inclusion

\[ A = \text{Min}(B, C); \text{EXCLU}() \] - will prompt for exclusion at run-time

\[ A = \text{Min}(B, C); \text{EXCLU}('\text{handle\_here}') \] - will use AutoCAD entity with specified handle for the exclusion

\[ A = \text{Min}(B, C); \text{PERIM}() \] - will prompt for polyline file with inclusions/exclusions

\[ A = \text{Min}(B, C); \text{PERIM('file\_name')} \] - will use specified file with inclusions/exclusions

Multiple inclusions or exclusions can be appended in this manner. Only points of target surface (A) passing inclusion/exclusion filter will be evaluated.

For custom, user define prompting, the following text should be used:

\[ \text{PERIM('Prompt goes here')} \] for user defined interactive inclusion and exclusion selection in CAD

\[ \text{PERIM(*,'Prompt goes here')} \] for file selection dialog with user defined prompts to select a PLN file.

**The following script functions are currently defined:**

**Macro functions (performing operations on the entire surface at once)**

\[ \text{LOAD()} \] Prompt user for the file to load. Returns a variable.

\[ \text{LOAD('Prompt goes here')} \] for user defined prompting

\[ \text{LOADFROM('string')} \] Load surface from file. Grids (GRD) and TINs (FLT, TIN) are supported. Returns a variable.

\[ \text{SAVE('Variable')} \] Saves surface back to original file.

\[ \text{SAVEAS('Variable','FileName')} \] Saves surface into a file with given name.

\[ \text{RELEASE('Variable')} \] Releases memory used by a surface and undefines it for further use.

\[ \text{EXTRAP('Variable[,Type]')} \]

**Micro functions (taking effect on point by point basis as controlled by left side of the equation)**

Expressions can be complex ones with variables, value and functions

\[ \text{MAX('Expression1','Expression2')} \] Sets value to larger of two expressions evaluated.

\[ \text{MIN('Expression1','Expression2')} \] Sets value to smaller of two expressions evaluated.

\[ \text{LESS('Expression1','Expression2','Expression3')} \] If result of Expression1 is less than Expression2 then result is Expression3. Otherwise the source point is not changed. If Expression3 is not specified value is set to NULL.

\[ \text{GREATER('Expression1','Expression2','Expression3')} \] If result of Expression1 is greater than Expression2 then result is Expression3. Otherwise the source point is not changed. If Expression3 is not specified value is set to NULL.

\[ \text{IF('Expression1','Expression2','Expression3')} \] If Expression1 (can be logic expression like (A+B)>C or A=B or A!B 'not equal') not 0 then result is Expression2, otherwise it is Expression3.

\[ \text{POW('Expression1','Expression2')} \] Result is value of Expression1 in power of Expression2

\[ \text{MERGE('Expression1','Expression2')} \] If Expression2 is valid at a point, then result is that value, otherwise it is value of Expression1

\[ \text{SET\_NULL('Expression1','Expression2')} \] If Expression1 is valid at a point, then result is that value, otherwise it is value of Expression2
CHANGE_RANGE_VALUE(Expression1, Range1, Range2, Expression2) If Expression1 is a valid point and its value is greater than equal to Range1 and less than equal to Range2, then result is Expression2. If Expression2 is not specified value is set to NULL.

Here is an example of a complex IF statement used for coal recovery based on thickness of the seam:

COALTHK=LoadFrom(C:\Carlson Projects\Grids\C40_THK.GRD);
ROM_COAL=COALTHK
ROM_COAL=if((COALTHK<2)→(COALTHK=2),COALTHK - (COALTHK * 0.50),ROM_COAL)
ROM_COAL=if(((COALTHK<4)→(COALTHK=4))&(COALTHK>2),COALTHK - (COALTHK * 0.10),ROM_COAL)
ROM_COAL=if((COALTHK<7)→(COALTHK>4),COALTHK - (COALTHK * 0.075),COALTHK - (COALTHK * 0.05))
SaveAs(ROM_COAL, C:\Carlson Projects\Grids\C40_ROM_THK.GRD)

Pulldown Menu Location: Surface
Keyboard Command: GFU
Prerequisite: Make a grid (.GRD) file with the Make 3D Grid File command.

Edit 3D Grid
This command edits the elevation of a grid node by graphically picking the grid corner and entering a new elevation. The grid is a surface model that is represented by a rectangular mesh of grid cells. Each grid cell has four corners with elevation. This command modifies the elevation of one of these grid corners. After picking the grid node to edit, the program draws a temporary X marker on the selected point and shows the current elevation for the point. Before running this routine, a grid (.GRD) file must be created with the Make 3D Grid File command. Also the grid must be drawn on the screen using the Draw Surface >> Draw 3D Grid File command. Besides updating the elevation of the grid in the drawing, the grid file may also be updated. Whether to update the grid file is specified at the first prompt in the program.

Prompts

Update drawing only (Yes/<No>?) press Enter Choose between modifying the grid drawing or both the grid drawing and file.
Select Grid node to edit: pick a grid cell corner
Enter new Grid node elevation <305.519>: press Enter
Select Grid node to edit: press Enter to end

Pulldown Menu Location: Surface > Modify Grid File
Keyboard Command: editgrid
Prerequisite: A .GRD File and drawn grid 3D Faces

Merge Grid Files
This command creates a grid file by merging together two existing grid files, grid1 and grid2. The current grid is grid1 and the program will prompt for a second grid. These two grids must overlap with the same location and resolution. The inclusion and exclusion perimeters apply to grid2 such that the merged grid will consist of grid2 cells within the inclusion perimeters and outside the exclusion perimeters and grid1 cells everywhere else. The result is stored in the current grid.
No elevations are calculated on grid cells that extend beyond the extent of the data. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. The prompt *Extrapolate grid to full grid size?* shows when there are grid cells with no elevation in a grid (.GRD) file. Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data.

**Prompts**

Select Source Grid 1 File Dialog *(file select dialog)*  
Reading cell > 93058  
Extrapolate grid to full grid size [Yes/<No>]? press Enter  
Select Source Grid 2 File Dialog *(file select dialog)*  
Reading cell > 62137  
Extrapolate grid to full grid size [Yes/<No>]? press Enter  
Overlap method: Hold grid 1, replace with grid 2 or average [Hold/Replace/<Average>]? press Enter  
Specify inclusion and exclusion areas for grid 2. Grid 1 used everywhere else.  
Select the Inclusion perimeter polylines or ENTER for none. select perimeter(s) or press Enter  
Select objects: press Enter to conclude selection  
Select the Exclusion perimeter polylines or ENTER for none. select perimeter(s) or press Enter  
Select objects: press Enter to conclude selection  
Merged Grid File to Write Dialog *(new file select dialog)*

Pulldown Menu Location: Surface >> Modify Grid File  
Keyboard Command: mergegrd  
Prerequisite: Two grid (.GRD) files

**One Triangulation Surface Volumes**

This command works similarly to the Grid-based one surface volume, but using a triangulation surface (.tin, .flt) file. It differs from the *Two Triangulation Surface Volumes* command in the same manner that the grid-based commands do, that is, it uses a flat reference plane as the second (final) surface instead of a defined triangulation surface file. Please refer to the *Two Triangulation Surfaces Volumes* for more details.

*Note*: the volume comparison of this routine uses the selected surface file as the *base* surface, and the target elevation plane as the *final* surface, so be aware that if your target elevation is set primarily below the surface defined by the triangulation file, it will report as cut, when in reality you may be filling above the target elevation plane to reach the defined surface.

**Prompts**

*(select triangulation surface dialog)*  
Loading edges...  
Loaded 9507 points and 27345 edges  
Created 17839 triangles  
Enter the reference elevation <0.0>: 1400 specify the reference plane elevation  
Select Inclusion polylines.  
Select objects: select inclusion boundary(ies) or Enter for none.  
Select Exclusion polylines.  
Select objects: select exclusion boundary(ies) or Enter for none.
Two Triangulation Surface Volumes

Volumes By Triangulation is a volume method that compares two triangulation networks. This method is different from the grid based volume routines (Volumes By Layer, One Surface Volumes, Two Surface Volumes, Stockpile Volumes, etc.) and the cross section volume routine (Calculate Section Volume). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismoidal volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 feet to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.
The triangulation networks to compare are defined in .tin or .flt files that are created by Triangulate & Contour with the Write Triangulation File option. Note that while both file formats are supported, the newer binary triangulation file format (.tin) is twice as fast to load and save, and half the size, of the .flt triangulation file format. For this reason, the .tin file format is recommended. Before using this command, run Triangulate & Contour twice to create an triangulation (.TIN or .FLT) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

**Shrink/Swell Factors**

An optional aspect of the Volumes by Triangulation routine is the ability to supply either a Cut "Swell" Factor and/or a Fill "Shrink" Factor to the results of the volume calculation. Having a solid understanding on the ramifications of each factor is important for determining how (and when) the values should be used for earthwork considerations.

The factors are commonly expressed as decimal differences from the "factor neutral" value of 1.00. In most cases, surface models are representations of what currently exists in the field or what is desired to exist after construction. Consider the following examples:

**Excavating a Pit**

Suppose you are given the task of designing a below ground storage pit. Based on your design surface model, the amount of Cut has been determined to be 1,000 C.Y.

**C.Y.Cut Swell Factor > 1 (example 1.15)**

Supplying a Cut Swell Factor greater than 1 would usually be taken to mean "How much volume will my 1,000 C.Y. of material occupy when it comes out of the ground?" With a 15% swell factor (1.15) applied, the 1000 C.Y. of excavated material would now occupy 1,150 C.Y. of space.

**Cut Swell Factor < 1 (example 0.85)**

Supplying a Cut Swell Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of material occupy in this hole when it has been compacted?" With a 15% compaction factor (0.85) applied, the 1000 C.Y. of material getting compacted would now occupy 850 C.Y. of the hole space.

**Working with a Stockpile**

Suppose you have a stockpile of material that is suitable for building purposes. Based on your design surface model, the amount of material has been determined to be 1,000 C.Y.

**Fill Shrink Factor > 1 (example 1.10)**

Supplying a Fill Shrink Factor greater than 1 (see NOTE below) would usually be taken to mean "How much volume would this 1,000 C.Y. of material occupy if it were picked up and deposited elsewhere?" With a 10% swell factor (1.10) applied, the 1000 C.Y. of stockpile material would occupy 1100 C.Y. of space.

**Fill Shrink Factor < 1 (example 0.90)**

Supplying a Fill Shrink Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of stockpile material occupy when it has been compacted?" With a 10% compaction factor (0.90) applied, the 1000 C.Y. of material getting compacted would now occupy 900 C.Y. of the hole space.

**Note:**

- In a design Fill scenario (such as a berm), often it is desired to know how much material would need to be brought in at a given compaction factor to occupy the design fill. To determine this value, use the following equation:

\[
\text{Fill Factor} = \frac{100.0}{(100.0 - \text{shrink\_percentage})}, \text{ using 15\% shrink as an example,}
\]

\[
\text{Fill Factor} = \frac{100.0}{(100.0 - 15.0)} = 1.17647
\]

**Prompts**
Select EXISTING Surface Triangulation File Choose an .flt or .tin file
Select FINAL Surface Triangulation File Choose an .flt or .tin file
Select Inclusion polylines.
Select objects: select objects that form a perimeter around the area of study
Select Exclusion polylines.
Select objects: select objects that form an exclusion area within the area of study

Cut Swell Factor: Supply an appropriate factor by which the calculated Cut volume should be multiplied.
Fill Shrink Factor: Supply an appropriate factor by which the calculated Fill volume should be multiplied.
Use Report Formatter: Choose between customizing the report and using the standard report.
Volume Units and Area Units: Choose the units to include in the report.
Calculate Elevation Zone Volumes: This option calculates cut/fill volumes within elevation ranges. The ranges use a specified elevation interval and can start from the top or bottom.
Report Tons: Enable this option to report the tonnage of Cut material and Fill material based on the material density.
Density: Indicate the average material density.
Write TIN Difference: Enable this option to create a TIN based on the elevation difference between the EXISTING surface and the FINAL surface.
Three Triangulation Surface Volumes

This command uses a set of three surface files, (.TIN, .FLT) to generate volumes between them. The user is prompted for the names of the three files as: Existing, for existing conditions, Final, for final design, and Strata, for a subsurface, such as rock. An Inclusion or Exclusion Perimeter can be selected, and then the Volume Report Options are presented. Picking OK generates the Volume Report.
The amount of Cut into the Strata surface is reported, as well as Other Cut, Total Cut and Total Fill. The Areas for the same are also reported. The volume and area of Overexcavation is also reported.

**Pulldown Menu Location:** Surface >> Volumes By Triangulation  
**Keyboard Command:** trivol3  
**Prerequisite:** 3 Surface Files (.FLT or .TIN)

### One Grid Surface Volumes

This command calculates the cut and fill volumes between the surface modeled by one grid (.GRD) file and a constant elevation or value. This is the same as Two Grid Surface Volumes except that the second surface is a flat plane at a constant elevation instead of a 3D grid surface. Please refer to that section for additional details. If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for these grid cells. There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to using this command.

**Note:** the volume comparison of this routine uses the selected grid file as the base surface, and the target elevation plane as the final surface, so be aware that if your target elevation is set primarily below the surface defined by the grid file, it will report as cut, when in reality you may be filling above the target elevation plane to reach the defined surface.

### Prompts

**Select the Inclusion perimeter polylines or ENTER for none:**
Select objects: press Enter

**Select the Exclusion perimeter polylines or ENTER for none:**
Select objects: press Enter
Specify Grid File Selection Dialog Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.
Enter the base elevation: 1500 This defines the second surface.

Volume Report Options Dialog

![Volume Report Options Dialog]

- Write Depth/Difference Grid File
- Draw Depth/Difference Contours
- Draw Depth/Difference in Each Cell
- Draw Volume in Each Cell
- Draw Cut/Fill Color Map
- Calculate Elevation Zone Volumes
- Use Report Formatter

- Cut Swel Factor: 1.000
- Fill Shrink Factor: 1.000
- Report Tons: Density (lbs/ft^3): 80,000

![Volume Report]

Comparing Grid: C:\Projects\Misc\2000 beta files\cu-2ds-merged.grd
Reference elevation: 1500.00
Grid corner locations: 2367870.26,195097.42 to 2368870.26,196697.42
Grid resolution X: 65, Y: 80 Grid cell size X: 20.00, Y: 20.00
Area in Cut: 611,370.3 S.F., 14.04 Acres
Area in Fill: 788,509.4 S.F., 18.10 Acres
Total inclusion area: 1,400,079.7 S.F., 32.14 Acres
Cut to Fill ratio: 0.68
Average Cut Depth: 12.63 Average Fill Depth: 14.50
Max Cut Depth: 26.56 Max Fill Depth: 31.21
Density: 80.00 (lbs/ft^3)
Cut (C.Y.) / Area (acres): 8699.28
Fill (C.Y.) / Area (acres): 13174.74
Cut volume: 7,722,937.4 C.F., 266,033.46 C.Y., 308,918.30 Tons
Fill volume: 81,433,279.2 C.F., 423,424.64 C.Y., 437,331.01 Tons

Chapter 6. Civil Module
**Cut/Fill Color Map Options**

**Pulldown Menu Location:** Surface >> Volumes By Grid Surfaces

**Keyboard Command:** volcalc1

**Prerequisite:** A grid (.GRD) file

---

**Two Grid Surface Volumes**

*Two Grid Surface Volumes* calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the *Make 3D Grid File* routine. When creating the second grid file, choose *Use position of another file* and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.
There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes. These routines have special prompting and calculate the grid surfaces and volume in one step.

Volumes by Two Surface Volumes has three steps:
1. Creating the first grid file with Make 3D Grid File
2. Creating the second grid file with Make 3D Grid File
3. Running Two Grid Surface Volumes

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the Volumes by Triangulation commands. Cross section end area is another volume method that is used by the Calculate Sections Volume command in the Civil Design module.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. **Important:** Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.

<table>
<thead>
<tr>
<th>Volume Report Options</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Write Depth/Difference Grid File</td>
<td></td>
</tr>
<tr>
<td>Draw Depth/Difference Contours</td>
<td></td>
</tr>
<tr>
<td>Draw Depth/Difference in Each Cell</td>
<td></td>
</tr>
<tr>
<td>Draw Volume in Each Cell</td>
<td></td>
</tr>
<tr>
<td>Draw Cut/Fill Color Map</td>
<td></td>
</tr>
<tr>
<td>Calculate Elevation Zone Volumes</td>
<td></td>
</tr>
<tr>
<td>Use Report Formatter</td>
<td></td>
</tr>
<tr>
<td>Process Another Area With Current Grids</td>
<td></td>
</tr>
</tbody>
</table>

**Write Difference Grid File** creates a grid (.GRD) file of the elevation difference of the two grid files.

**Draw Difference Contours** creates a contour map of the difference or depth between the two grid files.

**Draw Elevation Difference in Each Cell** plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.

**Draw Volume in Each Cell** plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.

**Calculate Elevation Zone Volumes** calculates the cut and fill between different elevation ranges.

**Draw Cut/Fill Color Map** fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells.
at zone transitions. Also, there is an option to control the zone intervals and range.

**Use Report Formatter** allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.

**Process Another Area with Current Grids** runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The **Cut Swell Factor** value is multiplied by the cut volume in the report.

The **Fill Swell Factor** value is multiplied by the fill volume in the report.

**Report Tons** allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with *Draw Surface >> Draw 3D Grid File* and viewing them with *the 3D Viewer* or by contouring the grids with the *Contour Grid File* command.

---

Existing surface

Final surface contours with a closed polyline

Contours from the Draw Depth/Difference Contours option. Cut contours are red, fill contours are blue, daylight contours are green. This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

**Sample Two Surface Volumes report:**
Comparing Grid: C:\scad2006\data\simo.grd
and Grid: C:\scad2006\data\final.grd
Lower left grid corner : 186551.67,57624.98
Upper right grid corner: 186828.81,57897.09
X grid resolution: 75, Y grid resolution: 75
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

Volumes by elevation zone
Zone 20.00 to 30.00
Cut volume : 0.30 cubic ft, 0.01 cubic yards
Fill volume: 107.90 cubic ft, 4.00 cubic yards
Zone 30.00 to 40.00
Cut volume : 4.88 cubic ft, 0.18 cubic yards
Fill volume: 73021.14 cubic ft, 2704.49 cubic yards
Running total:
Cut volume : 5.18 cubic ft, 0.19 cubic yards
Fill volume: 73129.05 cubic ft, 2708.48 cubic yards
Zone 40.00 to 50.00
Cut volume: 65044.26 cubic ft, 2409.05 cubic yards
Fill volume: 0.25 cubic ft, 0.01 cubic yards
Running total:
Cut volume : 65049.44 cubic ft, 2409.24 cubic yards
Fill volume: 73129.29 cubic ft, 2708.49 cubic yards
Zone 50.00 to 60.00
Cut volume : 17786.85 cubic ft, 658.77 cubic yards
Fill volume: 0.00 cubic ft, 0.00 cubic yards
Running total:
Cut volume : 82836.29 cubic ft, 3068.01 cubic yards

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter

Volume Report Options dialog
This shows a grid drawn by *Plot 3D Grid File* and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

**Pulldown Menu Location:** Surface >> Volumes By Grid Surfaces  
**Keyboard Command:** volcalc2  
**Prerequisite:** Two grid files

## Volumes By Layer

This is the easiest yet still equally accurate method for calculating volumes. For this command, volumes are calculated in one step by a simple window of the area, selecting the items, and *calculate*.

First, you must specify the grid location and resolution. The grid location should enclose the area for volume calculations. Next the program asks for the layer names of the entities for the base and final surfaces. You designate the layers to use for each surface either by typing the layer names or by picking from the screen, then during the routine you select the entities to use. You may safely use the keyword *ALL* to select the entities, since you have pre-defined the layers to use, and all those entities not on the specified layers will be filtered out. These entities, for use in modeling the surfaces, can be points, lines (such as triangulation lines), 2D polylines (such as contours), and 3D polylines (such as breaklines).

Inclusion and exclusion perimeters may optionally be specified to limit the volume calculation area on the grid. An inclusion perimeter should be used if there is a closed polyline for the limit of the disturbed area. Then the program internally generates grids of the surfaces from the entities on the corresponding layers and then calculates and reports the volume. The main disadvantage to this routine is that it doesn't have the special output options of *Two Grid Surface Volumes* such as Depth Contours.

### Prompts

**Command:** layervol  
**Pick Lower Left limit of surface area:** pick lower left corner of grid  
**Pick Upper Right limit of surface area:** pick upper right corner of grid
You are then prompted to designate layers:

*Press Select Layers from Screen* to show the routine which layers to use by selecting sample objects from those layers.

**Select entities on layers of Existing surface.** *select sample object(s)*

Select objects: Specify opposite corner: 3 found
Select objects: *press Enter* to conclude selection.

**Select entities on layers of Final surface.** *select sample object(s)*

Select objects: Specify opposite corner: 10 found
Select objects: *press Enter* to conclude selection.

Reading points ...

**Select surface entities on corresponding layers.**

Select objects: *all* filters out those objects not on designated layers
85 found
Select objects: *press Enter* to conclude selection.

Reading points ... 9396

Assigning grid values> 5300
Pass> 28 Null Z values left> 0
Writing grid file: C:\Documents and Settings\.\.\USER\grid1.grd
Assigning grid values> 5300
Pass> 43 Null Z values left> 0
Writing grid file: C:\Documents and Settings\.\.\USER\grid2.grd

Select the Inclusion perimeter polylines or ENTER for none: *select inclusion perimeter*

Select objects: 1 found
Select objects: *press Enter* to conclude selection.

Select the Exclusion perimeter polylines or ENTER for none.
Select objects: *press Enter* for none.

Reading cell> 5346
Pass> 28 Null Z values left> 0
Reading cell> 5346
Pass> 43 Null Z values left> 0
Pre-processing grid cells ....
Processing cells ...

Select point for color legend (Enter for None): *press Enter*
Cut/Fill Labels

This command displays the design elevation, the existing elevation, and the amount to either cut or fill directly on the screen. The design and existing elevations can be defined by triangulation files, grid files or points.

In the Elevation Difference Label Options dialog, you can customize the Cut/Fill labels. Text can be added either before or after the Cut/Fill amount, the Existing elevation, and the Design elevation with the Prefix and Suffix fields. You can also choose whether or not to display the Existing Surface elevations and the Design Surface elevations. The Draw Marker Symbol option draws an X symbol for where each label represents. The Hide Drawing Under Labels option creates Wipeout entities around the labels so that you can read the labels clearly. Text Size chooses the text size for each line of the label. Text Style allows you change the Font Style displayed in the labels. Decimal Places sets to how many decimal places the labels will report. The Cut/Fill In Inches labels in feet and inches to the specified precision. The Spacing Methods include:

- Fit: Uses an inclusion perimeter and the size of the labels to make a series of rows and columns of labels that fit within the perimeter. The Space Between Labels sets the buffer around labels. The size of each space is determined by the Text Size.
- Grid Interval: Places the labels at the specified Horizontal and Vertical Intervals starting with the specified Northing and Easting coordinate.
- Station Interval: Uses a centerline polyline and places the labels at a station interval along this alignment.
- Screen Pick: Prompts for each label position.

The following image shows the main dialog box for setting the labeling options.
The labeling created with these options looks like this:

```
PR117, 00
EX129, 59
  -12, 59

PR117, 00
EX129, 00
  -12, 00

PR117, 00
EX127, 40
  -10, 40

PR117, 00
EX127, 31
  -10, 31
```

The distribution of the labels on the site looks like this:
Pulldown Menu Location: Surface > Cut/Fill Utilities
Keyboard Command: elevdiff
Prerequisite: Existing and design surfaces

Cut/Fill Color Map

This command creates a cut/fill color map in red and blue in order to show the difference between grid or triangulation surfaces. The surface model sources can be either .tin, .flt, or .grd files.

For analyzing using the grid option, you need to already have two existing grid files. If the grids are not visible in plan view, you may want to have them display on-screen using the Draw 3D Grid File command. The grids should overlap with the same location and resolution. The resulting red/blue map with legend is shown below.

No mapping is calculated on tin or grid cells that extend beyond the extent of the data. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. The prompt **Extrapolate grid to full grid**
Prompts

For a color map showing differences between two grids:
Type of surface model source [Tin/<Grid>]? press T for a Triangulation (.TIN) file, or press Enter to accept default choice in brackets.
Select Base Grid File Dialog Select an existing .grd file.
Select Final Grid File Dialog Select a second existing .grd file.
Select Inclusion polyline: pick a closed inclusion perimeter
Select Exclusion polylines (Enter for none).
Select objects: pick exclusion polylines or press Enter
Cut/Fill Color Map Options Dialog
Select point for color legend: pick a point
Legend size <10.0>: press Enter
Label all zones or summary [All/<Summary>]? press Enter

Pulldown Menu Location: Surface >> Cut/Fill Utilities
Keyboard Command: cf_map
Prerequisite: Two grid (.GRD), triangulation mesh (.FLT) or tin (.TIN) files

Cut/Fill Grid Map

This command labels cut/fill quantities and creates a report at a grid interval over the site. The grid cells are square at a specified size. The cut/fill quantities are calculated separately within each grid cell. The options dialog controls which cut/fill fields to label and the label position within the grid cell. There is a summary row at the bottom of the
grid with the overall totals and sub-totals for each column.

After the options dialog, the program prompts for the corners for the area to grid. These corners should create a window around the site.

Then after drawing the grids and labels, the Report Formatter shows the cut/fill quantities for the grid cells. You can choose which fields to include in the report.

![Cut/Fill Grid Map dialog]

Prompts

Select Existing Triangulation File
Select Design Triangulation File
Select Inclusion polyline (Enter for none): select polyline
Select Exclusion polylines (Enter for none): press Enter
Cut/Fill Grid Map dialog
Pick first grid corner: pick a point
Pick second grid corner: pick a point
### Sample Report:

<table>
<thead>
<tr>
<th></th>
<th>Cell Cut (C.Y.)</th>
<th>Fill (C.Y.)</th>
<th>Cut Area Fill Area Total Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>14.1</td>
<td>2.0</td>
<td>505.3</td>
</tr>
<tr>
<td>2</td>
<td>0.4</td>
<td>639.2</td>
<td>45.2</td>
</tr>
<tr>
<td>3</td>
<td>10.0</td>
<td>627.7</td>
<td>565.6</td>
</tr>
</tbody>
</table>

...  

----- Grand Total -----  

|      | 2410.7 | 17155.5 | 30959.6 | 93877.1 | 125151.5 |

### Pulldown Menu Location:
Surface >> Cut/Fill Utilities

### Keyboard Command:
`cf_grid`

### Prerequisite:
Existing and design surfaces

### Cut/Fill Contours

This command displays the amounts of cut and fill between two surfaces by computing and displaying cut/fill contour lines representing the amount of cut or fill along that line. Cut contours are displayed in red (with negative values), fill in blue (positive values), while the lines of zero cut (the "daylight" lines) are displayed in green ("0" labels). You have the option to draw only the daylight lines, indicating the areas where the two surfaces intersect.

### Cut/Fill Contour Settings:

You set the contour settings in the opening dialog by selecting the `Cut/Fill Contour Settings` button, which is comprised of the `Contour` and `Labels` tabs identical to those in `Triangulate and Contour`. Please refer to that command for details on the dialog options. You may wish to designate alternate layer names for these sets of contours to avoid overwriting previous contours on surface layers, and generally you will set the contouring interval to 1 foot.
Type of surface model source [<Tin>/Grid]? press Enter to use triangulated surface file.

You are next prompted for some options:

Select Inclusion polyline: select inclusion boundary(ies) or Enter for none.
Select Exclusion polylines (Enter for None).
Select objects: press Enter

Loading edges...
Loaded 9507 points and 27345 edges
Created 17839 triangles

Loading edges...
Loaded 826 points and 2250 edges
Created 1425 triangles

Loading edges...
Loaded 18927 points and 54691 edges
Created 35765 triangles
Ignored 2942 points with zero elevation.
Contouring elevation 14 - Routine displays and updates the value in process
Inserted 10273 contour vertices.

Pulldown Menu Location: Surface >> Cut/Fill Utilities
Keyboard Command: cf_ctr
Prerequisite: Existing and design surfaces

Cut/Fill Centroids
This command finds the centroids for each cut and fill area between two triangulation surfaces (.flt or .tin files), with options to draw centroid boundaries, label centroid amounts (in cubic yards for English units), and hatch the areas. Included is a routine to find the optimum movement of the cut to fill volumes which minimizes the total haul distance moved. This routine finds all the areas of cut and fill, and locates the centroid for each area.
Prompts

Cut & Fill Centroid Locator Dialog
Select Original Ground Surface Dialog Select an existing surface (.tin, .flt) file
Select Design Surface Dialog Select an existing surface (.tin, .flt) file

Pulldown Menu Location: Surface >> Cut/Fill Utilities

Keyboard Command: cutfillc

Prerequisite: Two triangulation files, (.flt or .tin)

Cut/Fill Slope Lines

This command draws cut/fill slope lines with slope direction arrows. The arrowhead points in the downward direction of the slope. The cut/fill slopes are defined by selecting a 3D polyline for the top of slope and another 3D polyline for the toe of slope.
In the options dialog, the Style chooses the type of symbol to draw: arrow, Y or 3-line. The Interval sets the spacing of the slope lines along the top of slope polyline. There are settings for the arrowhead size and the layer for the slope lines. The Solid Cut Arrows option allows for different style arrowheads for cut and fill slopes. The Hatch Settings control whether to hatch the area between the top and toe 3D polylines and the hatch properties to use.

Arrow style slope lines

Y style with solid hatch in yellow
Prompts

Draw Cut/Fill Slope Lines dialog
Pick top of slope polyline: pick a 3D polyline
Pick toe of slope polyline: pick a 3D polyline

Pulldown Menu Location: Surface > Cut/Fill Utilities
Keyboard Command: slope_lines
Prerequisite: 3D polylines for top and toe of slope

Draw 3D Poly Perimeter

This command draws a 3D polyline on the PERIMETER layer. This is one way to generate the polyline that is required by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines. In these routines, this polyline is used as the inclusion perimeter for volumes. If you are using Carlson points to define the polyline, make sure they are present in the drawing at their real Z elevation, and then set your Object Snap to Insert prior to running this routine. Alternately, you can use point numbers from the current coordinate (.CRD) file. A third option is to obtain the elevations of picked points from a specified surface model. You have a further option to be prompted for each elevation, thus overriding the values found from the included points.

Prompts

If set to display, the 3D Poly options dialog will appear, and then you will be prompted for points to use to draw the 3D Poly Perimeter. Standard Carlson point number input or screen picks using selection methods are valid.

Dialog Options
**Prompt for Elevation/Slope:** Using the .XY filter allows the user to pick the X and Y coordinate from the screen and type in the elevation. If you use the No response then the Z coordinate of the point picked will be applied.

**Use surface model from file:** With this option, a surface file is specified, and then with each screen pick, the surface elevation is determined. If Prompt for elevations is set to No, the surface elevation is applied to the polyline vertex. If set to Yes, the surface elevation is displayed as the default, and can be accepted by pressing Enter, or a different elevation can be typed in instead.

**Pick point or point number:** *pick a point or type a point number*

**Arc/Close/Undo/Pick point or point number:** 15 This is a point number from the current coordinate (.CRD) file.

Note that if the response to Use Surface model from file is Yes, the elevation used is not the point elevation from the coordinate file (.CRD), but the elevation interpolated from the surface.

**Arc/Close/Undo/Pick point or point number:** *press Enter*

Draw another 3D polyline [Yes/<No>]? *press Enter* Pressing Enter ends the command.

**Pulldown Menu Location:** Surface >> Stockpile/Pond/Pit Volumes

**Keyboard Command:** 3dperim

**Prerequisite:** None

---

**Draw 3D Poly Base Breakline**

This command draws a 3D polyline in the BASE_BREAKLINE layer. This polyline is used by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines to model the base surface. You may want to set your Object Snap prior to running this routine so that you obtain the elevations of existing points while creating the 3D polyline. Besides picking and entering the points, you can also use point numbers from the current coordinate (.CRD) file.

This routine functions identically to the Draw 3D Poly Perimeter command, only placing the resulting 3D polyline on a different layer.

**Pulldown Menu Location:** Surface > Stockpile/Pond/Pit Volumes

**Keyboard Command:** 3dbase

**Prerequisite:** None

---

**Calculate Stockpile Volume**

This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is above the perimeter elevation, such as in the case of a stockpile of material. The complimentary command, Calculate Pond/Pit Volume, is for the opposite situation, in which the entire volume to be calculated is below the elevation of the perimeter.

The program internally computes BASE and FINAL grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select another 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation.
Additional 3D polylines can also be specified to more precisely define the BASE surface. These must be on the BASE_BREAKLINE layer to be used for this purpose. These can be generated by the Draw 3DPoly Base Breakline routine.

The FINAL surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASE_BREAKLINE polylines. These features are used only in computing the BASE surface.

You have the option of setting the resolution of the grids. There is also an option to report the fill volume in stages at an elevation interval.

The Make 3D Grid File and Two Grid Surface Volumes commands, used in combination, are an alternative to this command, and in any situation in which there are cut and fill volumes between the surfaces, that combination must be used to generate accurate results.

**Prompts**

Material density lbs/ft^3 (Enter for none): enter a material density in lbs per cubic foot, or press Enter for none

Ignore Zero Elevations [<Yes>/No]?

Select stockpile entities and perimeter.

Select objects: pick the objects that define the stockpile and the 3D polyline perimeter

Select stockpile perimeter polyline:

![Make 3D Grid File dialog](image)

Make Grid File dialog Set the resolution and then click OK.

![Stockpile Volume Report](image)

Sample volume report

**Volume Report**

Lower left grid corner : 5173.56,3970.45
Stockpile volume: 1,251,818.0 C.F., 46,363.63 C.Y.
Area: 58,790.9 S.F., 1.350 Acres
Elevation Range: 543.03 to 596.32

Increment Volume (C.Y.) (C.F.)
549.00-555.00 9863.2 266305.4
555.00-561.00 7868.5 212450.6
561.00-567.00 6161.5 166359.4
567.00-573.00 4618.4 124697.4
573.00-579.00 3226.7 87121.7
579.00-585.00 2175.9 58750.5
585.00-591.00 1004.7 27127.8
591.00-596.32 111.7 3015.6

Stockpile defined by points and a 3D polyline perimeter
Window these objects to obtain the volume report

Pulldown Menu Location: Surface >> Stockpile/Pond/Pit Volumes
Keyboard Command: stockvol
Prerequisite: Data representing the stockpile surface and a 3D polyline representing the perimeter of the stockpile.

Calculate Pond/Pit Volume
This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is below the perimeter elevation, such as in the case of a pond or pit. The complimentary command, Calculate Stockpile Volume, is for the opposite situation, in which the entire volume to be calculated is above the elevation of the perimeter.

The program internally computes BASE and FINAL grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select the 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation.

Additional 3D polylines can also be specified to more precisely define the BASE surface. These must be on the BASE_BREAKLINE layer to be used for this purpose. These can be generated by the Draw 3D Poly Base Breakline...
The FINAL surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASE_BREAKLINE polylines. These features are used only in computing the BASE surface.

You have the option of setting the resolution of the grids.

Besides reporting the entire volume between the two surfaces, the report also includes the volumes at an elevation interval from the bottom to the top. These stage-storage volumes can also be stored to a capacity file (.cap) that can be used with the Hydrology module. In addition to the stage-storage volumes, the Report Incremental Volumes option reports the storage within an elevation range instead of relative to the surface.

The Make 3D Grid File and Two Grid Surface Volumes commands, used in combination, are an alternative to this command, and in any situation in which there are both cut and fill volumes between the surfaces, that combination must be used to generate accurate results.

**Prompts**

Ignore Zero Elevations [<Yes>/No]? press Enter
Select Pond/Pit entities and perimeter.
Select objects: pick the objects that define the surface and the 3D polyline perimeter
Select Pond/Pit perimeter polyline: pick the polyline

Make Grid File dialog Set the resolution and then click OK.

Sample Volume Report:
Lower left grid corner : 8361.29,10856.76
Pond/Pit volume: 602,182.5 C.F., 22,303.06 C.Y., 13.82 Acre-Ft
Area: 114,312.7 S.F., 2.624 Acres
Elevation Range: 987.08 to 1000.00

Storage Volumes
Elevation Storage(AcreFt) (C.Y.) (C.F.) Area(Acre)
990.00 0.26121 421.4 11378.5 0.281
992.00 1.18631 1913.9 51675.9 0.646
994.00 2.85639 4608.3 124424.4 1.033
996.00 5.46346 8814.4 237988.4 1.591
998.00 9.13982 14745.6 398130.8 2.083
1000.00 13.82421 22303.1 602182.5 2.624

Increment Storage(AcreFt) (C.Y.) (C.F.) Area(Acre)
990.00-992.00 0.92510 1492.5 40297.4 0.365
992.00-994.00 1.67008 2694.4 72748.5 0.387
994.00-996.00 2.60707 4206.1 113564.0 0.558
996.00-998.00 3.67636 5931.2 160142.4 0.492
998.00-1000.00 4.68438 7557.5 204051.7 0.541

Pulldown Menu Location: Surface >> Stockpile/Pond/Pit Volumes
Keyboard Command: pitvol
Prerequisite: Data representing the pond/pit surface and a 3D polyline representing the perimeter of the pond/pit.

Design Pad Template
This command creates design slopes from a perimeter polyline at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyline representing the outside edge of the feature to model. The edge is drawn as a polyline which can be either a 2D or 3D closed or open polyline. For a 2D polyline, the program will prompt for an elevation for the pad perimeter. With a 3D polyline, the pad perimeter is set to the elevations of the 3D polyline. For an open polyline, the program will prompt for the side for the design. With a closed polyline, the program designs the slopes either outward or inward depending on the settings in the dialog.
Under **Source of Slope Target Surface Model**, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a **Slope Direction from Closed Plines** option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

The **Slope Projection Perpendicular To** option applies to sloping pad perimeters. The Pad Polyline method creates the user-specified slope perpendicular to the pad perimeter. The Slope Direction method accounts for the slope of the pad perimeter and makes the final surface to match the user-specified slope. For example, if the pad perimeter is at a 10% slope and the fill slope is at 2:1, then the Pad Polyline method would create fill slopes that are 2:1 perpendicular to the pad while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping pad perimeter. For the same case except with the Slope Direction method, the resulting slope perpendicular to the pad is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

Under **Design Slope Format**, choose between **Ratio**, **Percent**, **Degree** or **Template**. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the **Design Template** routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the **Profile to 3D Polyline** command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the **Process Road Design** command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.
The **Force Cut** option will try the cut slope to find a catch point even when the pad perimeter starts out in fill. This is possible when the existing ground is rising faster than the cut slope. Likewise the **Force Fill** option will try the fill slope to find a catch point when the pad starts out in cut.

The **Process Multiple Pad Polylines** option allows you to process multiple pad perimeter polylines at a time instead of a single pad perimeter. The program will prompt for a selection set of pad perimeter polylines and then cycle through and run the design on each one. There will be one final report for the earthworks for all the pads. The Setup function allows you to specify different cut/fill slopes by layer and also to set the processing order by layer. For example, in the case of processing both building pads with a shallow slope and ditch polylines at a steeper slope, you could set up the processing order to do the building pad first and the ditch last so that the ditch cut slopes will carve out any overlap with the building fill slopes. These pad layer slope and order assignments can be saved and loaded from a .PAD file.

![Multiple Pad Processing Order](image)

**Use Another Surface for Pad Interior** will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

**Use Different Slopes for Separate Sides** allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.
**Use Slope Pad Design** allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.

**Draw Slope Direction Arrows** draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

**Solid Cut Arrows** allows you to choose between drawing the cut arrows as solid filled or as wire frame.

**Round Exterior Corners** holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

**Erase Previous Pad Entities** erases drawing geometry created with this command previously.

When **Draw Side Slope Polylines** is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

**Color Side Polylines** assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Example of pit design for option of Use Another Grid for Pad Interior

Side Polyline Spacing specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.

Corner Delta Angle is the delta angle in degrees between side slope polylines to span the delta angle around exterior corners.
Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

The **Contour Pad** option draws contours on the pad. At the end routine, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

The **Write Final Surface** option creates a surface model of the pad using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else. At the end of the routine, the program will prompt for the surface file name to create.

The **Trim Existing Contours Inside Pad** option trims existing contours inside the disturbed limits of the pad.

You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polyline which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD,.FLT,.TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in **Design Pad**. You could also create a TIN surface of the design surface using **Triangulate and Contour**. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running **Make 3D Grid File** or **Triangulate and Contour** and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated.

**A few Key things to note:**

1. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).
2. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).
3. If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.
4. If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to create a new surface of the combined surfaces.
5. If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.
Prompts

First you are presented with the Design Pad Template dialog box.

If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:

**Pick the top of pad polyline:** select perimeter polyline

Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:

**Pick Lower Left limit of pad disturbed area:** pick lower left These prompts appear for the Screen Entities surface model method.

**Pick Upper Right limit of pad disturbed area:** pick upper right Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.

**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then,

**Pick the top of pad polyline:** select perimeter polyline

Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio <2.0>:** 2.5
**Enter the cut outslope ratio <2.0>:** 2.5 After entering outslopes slope ratios, a range of elevations along the pad top will be noted.

**Enter the pad elevation <29.54>:** 39

**Calculate earthwork volumes (<Yes>/No)?** press Enter


**Adjust parameters and redesign pond (Yes/<No>)?** press Enter

**Write final surface to grid file (Yes/<No>)?** press Enter

**Trim existing contours inside pad perimeter (Yes/<No>)?** press Enter

**Contour the pad (<Yes>/No)?** press Enter

Existing contours with top of pad perimeter polyline
Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad

Template to apply in Design Pad Template

Existing surface with 3D polyline centerline
Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours

Viewpoint 3D view of Design Pad Template
Design Pad Template can also handle self-intersecting side slopes

Viewpoint 3D view of intersecting side slopes

**Pulldown Menu Location:** Surface  
**Keyboard Command:** pad  
**Prerequisite:** A pad perimeter polyline and surface entities or a surface file for an intercept target.

**Edit Pad Template**

This command is used in conjunction with Design Pad Template. It allows the user to modify an existing pad design that has been generated with Design Pad Template. The original design criteria of the pad can be modified and the routine will automatically re-calculate volumes, re-draw contours, disturbed limits, tin lines, etc. Possible modifications to the pad include cut/fill slopes, pad elevation, x-y position (the pad can moved to a new location), horizontal offset, a single pad vertex can moved to a new location, a new target surface can be specified, and finally, the pad and all of its elements can be deleted. Once the new design parameters are set, the routine will regenerate
the pad based on the new parameters. The standard report viewer opens to display the new volume calculation and other design info.

Edit Pad Template requires a target surface to project to, which is typically the surface designated as the Source of Slope Target Surface Model in the Design Pad Template command. In Design Pad Template, when prompted to "Update Surface File" select Yes.

First the user is prompted to pick the pad polyline, which must be the original polyline used with Design Pad Template command. Subsequent edits to the Pad Template must also be initiated with the selection of that polyline. The Editing functions are displayed in an interactive docked sidebar dialog.

Use Slope Groups allows the assignment of varied slopes along the length of the Pad Template. Select the checkbox, and pick the Set button to access the Assign Pad Cut/Fill Slopes dialog box.

Fill Slope: displays the original fill slope criteria, select to edit to a new value.

Cut Slope: displays the original cut slope criteria, select to edit to a new value.

Elevation Delta: enter a value to adjust the elevation of the entire pad template.

Pad Volume: displays the cut/fill volume generated with the last use of either Design Pad Template or Edit Pad Template.

Surface: displays the target surface, pick Set button to change.

Move Pad: Pick to move the Pad Template to a new location on the site. The user is prompted at the command line to "Pick start point for translation" and then "Pick end point for translation." The pad is moved to the new location, with contours, tin lines, disturbed area and volumes regenerated on the fly.

Move Vertex: Pick to move a vertex on the Pad Template. The user is prompted to screen select any vertex within the pad and place it in a new location. The pad vertex is moved to the new location, with contours, tin lines, disturbed area and volumes regenerated on the fly.
Offset: Pick to apply a horizontal offset of the pad perimeter polyline. Enter the amount of offset desired in the field and then specify whether it is to go in or out.

Note: For subsequent operations of Edit Pad Template, the original pad polyline must be selected when prompted. The offset pad polyline is not eligible for selection.

![RedesignOffset dialog](image)

Rotate Pad: Pick to rotate the Pad Template.

Balance: Pick to automatically adjust the Pad Template elevation to balance the cut and fill volumes.

Delete: removes all of the pad design entities that were generated with Design Pad Template or Edit Pad Template.

Report: Pick to generate a cut/fill volume report.

Process: proceeds with the re-design of the pad using the current criteria.

Pulldown Menu Location: Surface

Keyboard Command: repad

Prerequisite: A Pad Template generated with the Design Pad Template command, and the surface model file used as a target surface.

Design Bench Pond

This feature will design a pond from a closed 2D polyline that defines the top dam perimeter of the pond. Before beginning this routine, you must have surface entities or surface files and a closed polyline that represents the top of the dam. The command creates a top of dam of the specified width, and then projects inward to model the pond, and outward to model the slopes to match to the target surface. Besides drawing the bench pond in 3D, the command also reports the earthwork to build the pond and the stage-storage data. There is also an option to output the stage-storage data to a .CAP file to use with Draw Stage-Storage or for hydrograph routing. After creating the pond and reporting the earthwork and stage-storage, the program prompts whether to adjust the design. There are three types of adjustment. One adjustment is to balance the earthwork cut/fill by adjusting the design elevation. Another adjustment is to resize to meet a specified stage-storage. The target storage adjustment can be done by either changing the pond bottom elevation or by offsetting the pond perimeter in or out. The third type of adjustment is to manually change one of the design parameters such as slopes or elevations.

This command starts with the dialog shown here.
Source of Surface Model: The existing surface may be defined by a 3D rectangular grid mesh (.grd file), a triangulation file (.flt or .tin file), or by screen entities. If the "Screen Entities" option is chosen, a grid file representing the existing surface will be internally created by using the user selected screen entities that depict the surface (Contours, Tri-Mesh, 3D Polys).

Design Slope Formula: Choose how you want to specify the slopes, either by ratio, percent or degree.

Pond Bottom Surface: Choose how to specify the pond bottom surface, either use the original surface, sloped surface, or use a fixed set elevation.

Pond Polyline Reference: The program will prompt you to select a pond perimeter polyline from the drawing. With this option, you can choose between using a perimeter polyline that represents the pond top bench or the pond bottom perimeter.

Draw Slope Direction Arrows: This option draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

Arrow Size: Specify the size for the slope direction arrows.

Draw Side Slope Polylines: This option draws 3D polylines from the pond top bench to the outside catch perimeter and inside to the pond bottom.

Color Side Polylines: This option will color the side slope polylines as red/blue for cut/fill.

Side Polyline Spacing: Defines the interval along the top of pond perimeter to draw 3D lines from the top of pond to the tie at the outslope.

Cut Swell Factor: This value is multiplied by the earthwork cut volume for the report.

Fill Shrink Factor: This value is multiplied by the earthwork fill volume for the report.

Dam Top Width: Specify the width for the top of the dam.
**Remove Top Bench in Cut**: If this option is checked ON and the top of dam is in cut, then the bench will be removed.

**Use Interior Benches**: This option puts in up to two safety benches on the pond interior slope. The depth for the benches can be specified from either the top or from the bottom of the pond. If you only have one bench, then the fields for the second bench should be set blank.

![Diagram of pond interior slope with bench settings](image)

**Pond Layer Name**: Specify the layer for the pond entities.

The design is drawn as 3D polylines with an option to drawn contours on the pond, and the earthwork volumes and stage-storage volumes are calculated.

**Prompts**

First the Design Bench Pond dialog box is presented.

If the Source of Surface Model is set to Screen Entities, when you pick OK you are prompted to:

- **Pick Lower Left limit of pond disturbed area**: *Pick lower left*
- **Pick Upper Right limit of pond disturbed area**: *Pick upper right* Be sure to pick these limits well beyond the area of the top of dam polyline in order to make room for the outslopes.

**Make Grid File Dialog**: Specify the grid resolution desired and select OK. Carlson Civil generates a 3D grid that represents the existing surface, using the drawing entities that fall within the specified area.
You are then prompted to:

**Pick the top of dam polyline:** *Select closed polyline*

Then proceed to design the pond...

**If the Source of Surface Model is set to Surface File, when you pick OK, you are prompted to:**

**Pick the top of dam polyline:** *Select closed polyline*

Then select the Existing Ground Surface Model file to use. Then proceed to design the pond...

**Enter the fill outslope ratio <2.0>:** *Enter*

**Enter the cut outslope ratio <2.0>:** *Enter*

**Enter the fill interior slope ratio <2.0>:** *Enter*

**Enter the cut interior slope ratio <2.0>:** *Enter*

![TOP OF DAM POLYLINE](image)

Existing contours with top of dam polyline
Bench Pond showing Slope Direction Arrows and complete with contours

Range of existing elevations along dam top: 2033.75 to 2041.81
Enter the top of bank elevation <2033.75>: press Enter to accept the default which is the lowest surface elevation along the perimeter
Enter the pond bottom elevation: 2012.55
Method to specify storage elevations [<Automatic>/Interval/Manual]? press Enter If manual is selected the user can specify the elevation(s) to calculate.
Pond Report viewer that shows the earthwork volumes and stage-storage data
Adjust parameters and redesign pond [Yes/<No>?] Y

If yes is chosen for adjust, the following 7 prompts appear along with the report again:
Balance cut/fill [Yes/<No>?] press Enter for No. Yes will adjust the pond elevation to balance the cut/fill earthwork.
Enter the fill outslope ratio <2.00>: 2.5
Enter the cut outslope ratio <2.00>: 2.5
Enter the interior slope ratio <2.00>: 2.5
Enter the top of dam width <10.00>: press Enter
Enter the top of bank elevation <2033.75>: press Enter
Enter the pond bottom elevation <2012.55>: press Enter
Offset top of dam polyline [Yes/<No>?] Y
If yes is chosen for offset, the following 2 prompts appear:
Offset inwards or outwards [<In>/Out]? press Enter
Enter the amount to offset: 5
Method to specify storage elevations [<Automatic>/Interval/Manual]? press Enter
Pond Report viewer that shows the earthwork volumes and stage-storage data
Adjust parameters and redesign pond [Yes/<No>?] N

Write stage-storage file (Yes/<No>)? press Enter. This option creates a .cap file to use with Draw Stage-Storage Curve and to use for hydrograph routing.
Update target surface file [Yes/<No>?] press Enter. This option is available when the target surface is a triangulation file. The bench pond design will be merged into the target surface to update the triangulation file.
Write final surface to grid file [Yes/<No>?] press Enter
Trim existing contours inside pond perimeter [Yes/<No>?] Y

If yes is chosen, the following 2 prompts appear:
Retain trimmed polyline segments [Yes/<No>?] Y
Specify layer name for trimmed segments [Yes/<No>?] press Enter
Contour the pond [Yes]/[No]? press Enter

Refer to Triangulate & Contour section of the manual for a full explanation of Contour Options settings.

Bench Pond Design Report

Top of dam elevation: 40.0000
Bottom of pond elevation: 28.0000
Top of dam width: 10.0000
Cut slope percent grade: 40.00, slope ratio: 2.50
Fill slope percent grade: 40.00, slope ratio: 2.50
Interior slope percent grade: 50.00, slope ratio: 2.00

Lower left grid corner: 186395.20,57620.23
Upper right grid corner: 186803.82,57872.93
X grid resolution: 50, Y grid resolution: 50
X grid cell size: 8.17, Y grid cell size: 5.05

Pond EarthWork Volumes
Total fill: 2087.624 C.Y., 56365.84440 C.F.
Total cut: 772.791 C.Y., 20865.34961 C.F.

Pond Storage Volumes
Water Elev: 30.00, Pond Storage: 179.887 C.Y., 4856.94921 C.F.
Water Elev: 32.00, Pond Storage: 453.708 C.Y., 12250.12126 C.F.
Water Elev: 34.00, Pond Storage: 817.981 C.Y., 22085.48186 C.F.
Water Elev: 36.00, Pond Storage: 1321.035 C.Y., 35667.93750 C.F.


**Edit Bench Pond**

This command is used in conjunction with *Design Bench Pond*. It allows you to modify an existing pond design that has been generated with Design Bench Pond. The original design criteria of the pond can be modified and the routine will automatically re-calculate volumes, re-draw contours, disturbed limits, tin lines, etc. Possible modifications to the pond include cut/fill slopes, pond elevations, x-y position (the pond can moved to a new location), horizontal offset, a single pond vertex can moved to a new location, a new target surface can be specified, and finally, the pond and all of its elements can be deleted. Once the new design parameters are set, the routine will regenerate the pond based on the new parameters when the Process button is selected. The standard report viewer opens to display the new volume calculation and other design info.

Edit Bench Pond requires a target surface to project to, which is typically the surface designated as the Source of Slope Target Surface Model in the Design Bench Pond command. In Design Bench Pond, when prompted to "Update Surface File" select Yes.

The Edit Bench Pond command starts with a prompt to pick a pond polyline which can by any of the side slope or perimeter polylines created by the Design Bench Pond command. Another way to start Edit Bench Pond is to double-click on one of the pond polylines.

When the command starts, a dialog is docked on the left side of the drawing window. This dialog allows you to edit the pond while still being able to run other commands.
**Fill Out Slope:** displays the original fill slope criteria, select to edit to a new value.

**Cut Out Slope:** displays the original cut slope criteria, select to edit to a new value.

**Fill Interior Slope:** displays the pond interior slope for fill condition, select to edit to a new value.

**Cut Interior Slope:** displays the pond interior slope for cut condition, select to edit to a new value.

**Top Elevation:** enter the top elevation of the pond.

**Bottom Elevation:** enter the bottom elevation of the pond.

**Pond Earthworks:** displays the cut/fill earthworks and storage volume calculated with the last use of either Design Bench Pond or Edit Bench Pond.

**Surface:** Displays the target surface, pick Set button to change.

**Move Pond:** Pick to move the pond a new location on the site. The user is prompted at the command line to "Pick start point for translation" and then "Pick end point for translation". The pond is moved to the new location, with contours, tin lines, disturbed area and volumes regenerated on the fly.

**Move Vertex:** Pick to move a vertex on the top of pond perimeter. The user is prompted to screen select the vertex to edit and place it in a new location.

**Offset:** Pick to apply a horizontal offset of the top of pond perimeter polyline. Enter the amount of offset desired in the field and then specify whether it is to go in or out.

**Rotate Pond:** Pick to rotate the pond.

**Balance:** Pick to automatically adjust the pond elevation to balance the cut and fill volumes.
Delete: removes all of the pond design entities.

Report: Pick to generate a cut/fill volume and stage-storage report.

Process: proceeds with the re-design of the pond using the current criteria.

Pulldown Menu Location: Surface->Design Pond
Keyboard Command: edit_bpond
Prerequisite: A Bench Pond generated with the Design Bench Pond command, and the surface model file used as a target surface.

Design Valley Pond
This feature will design a valley pond, essentially by creating a dam across a low area, beginning with a surface model file (.GRD, .TIN, .FLT), or screen entities representing the surface, and a 2D polyline that defines the top of dam. These components must be present before starting. If Screen Entities are used, the program internally creates a grid mesh from the surface entities (Contours, Tri-Mesh, 3D polys) found by doing a crossing selection of the grid limit.

The design is drawn as 3D polylines with an option to drawn contours on the pond, and the earthwork volumes and stage-storage volumes are calculated.

The Cut Pond Interior option has two methods for cutting volume from the pond interior. This cut will create more water storage. The trace method prompts you to define a 3D polyline by picking points starting at the dam and going around the pond counterclockwise. At each point you enter an elevation. The default is the current ground elevation and typically you would enter a lower elevation. Then you enter a cut slope and the program will cut from this perimeter polyline at the entered slope. The polyline method requires a pre-drawn closed polyline inside the pond. The program will ask for a depth to cut and a cut slope. Polyline is set to the current ground elevation minus the cut depth. Then the program cuts out from the polyline to the original ground at the cut slope.

Prompts

![Design Valley Pond dialog box]

For Screen Entities method:
Pick Lower Left limit of pond disturbed area: pick lower left
Pick Upper Right limit of pond disturbed area: pick upper right Be sure to pick these limits well beyond the area
of the top of dam polyline in order to make room for the outslopes.

**Make 3D Grid File Dialog**

After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

**Pick the top of dam polyline**: *select a 2D polyline*

**Pick a point within the pond**: *pick a point*

**Enter the fill outslope ratio** <2.0>: 2.5 *Enter*

**Enter the cut outslope ratio** <2.0>: 2.5 *Enter*

**Enter the top of dam elevation**: 90 *Enter*

---

**TOP OF DAM POLYLINE**

Existing contours with top of dam polyline

Valley Pond showing Emergency Spillway

**Choose method to specify storage elevations** (<Automatic>/Manual)? *Enter* If manual is selected the user can specify the elevation(s) to calculate.

**Adjust parameters and redesign pond** (Yes/<No>)? *Enter* If yes, the user will be able to enter new slope ratios and dam widths etc...
Pulldown Menu Location: Surface > Design Pond in Civil, Structure in Hydro
Keyboard Command: vpond
**Prerequisite:** Polyline that defines top of dam

### Draw Triangular Mesh

This command draws a triangulation (.flt or .tin) file as either 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.

Triangulation (.flt or .tin) files can be created by *Triangulate & Contour*.

### Prompts

**Select TMESH File to Draw**

Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:

![Draw Triangulation Options](image)

If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

**Loading edges...**

**Loaded 198 points and 234 edges**

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window.
**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** `drawtri`  
**Prerequisite:** A triangulation (.flt or .tin) file

## Draw 3D Grid File

This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a 3D Face entity, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: *3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.*

![Draw 3D Grid File dialog box](image)

If **Use Vertical Exaggeration** is checked, grid elevations are multiplied by the value specified.

**Exaggeration Method** specifies whether to use an *Absolute* exaggeration method or *Relative to Base*, which uses the specified base elevation.

Specify the type of entities to draw in **Draw Method**. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However, these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in `VG` for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in **Layer Name**.

Specify the initial viewing direction in **View**.

When **Color by Elevation** is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.
When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation, it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the **3D Viewer Window** command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.

When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.

When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

![Drawn grid file using inclusion perimeter and side faces option viewed with Viewpoint 3D](image)

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** plotgrid  
**Prerequisite:** a grid (.GRD) File

---

**Quick Draw Surface**

This command draws lines for the edges of a selected triangulation model. The purpose of this routine is to quickly get a picture of the triangulation connections. The lines are drawn as temporary graphics that get cleared when the display is redrawn. To create triangulation entities, use other routines such as Draw Triangular Mesh.

**Prompts**

**Select Triangulation File**  
Choose the surface to draw

**Pulldown Menu Location:** Surface > Draw Surface  
**Keyboard Command:** quicksurf
Prerequisite: a surface file (.TIN, .FLT)

Quick Contours
This command draws contours for a selected triangulation model at a given contour interval. The purpose of this routine is to quickly get a picture of the surface model from the contours. The contours are drawn as temporary graphics that get cleared when the display is redrawn. To create contour entities, use other routines such as Contour From TIN File or Triangulate & Contour.

Prompts

Select Triangulation File
Choose the surface to contour
Contour interval <5.00>: press Enter

Pulldown Menu Location: Surface > Draw Surface
Keyboard Command: quickctr
Prerequisite: a surface file (.TIN, .FLT)

Draw Surface Boundary
This command draws the exterior perimeter of a triangulation or grid surface as a polyline. This is a simple way to show the size, shape and location of a surface without adding a lot of drawing entities and file size to the drawing.

The program prompts for the layer of the polyline to create and the type of polyline. A 2D polyline is drawn at zero elevation. A 3D polyline uses the surface elevations. There is an option for Label Polyline which adds text labels along the polyline with the specified name, size and interval. This label can be helpful to identify different surface boundaries.

Pulldown Menu Location: Surface >> Draw Surface
Keyboard Command: grdlimit
Prerequisite: a surface file (.GRD, .TIN, .FLT)

Draw Surface Intersection
This command draws a 2D or 3D polyline at the intersection of two surfaces. In addition to this choice, the dialog also allows for the specification of the layer to draw the polylines on, whether or not to smooth them, and whether or not to reduce vertices.
Pulldown Menu Location: Surface >> Draw Surface
Keyboard Command: grdcross
Prerequisite: two surface files (.GRD, .TIN, .FLT)

Surface Inspector
This command allows you to report and optionally label elevations for selected surface files. You can simultaneously analyze up to nine different surface files. Surface files can be either triangulation (.flt or .tin) files, grid (.grd) files, or any combination thereof. The following dialog opens when the command is initiated:

Symbol Name displays the symbol name to be plotted.
Click Select Symbol to select the symbol from the symbol library.
Text Size sets the actual size (not scale factor) of the text label placed in the drawing.

Turn the Draw Label Symbol at Surface Elevation toggle ON if you want the symbol to be located at the actual elevation of the surface.
Name denotes the name that will be plotted when you label the elevation. The default value is the same as the name of the surface file, but you can change it.

**Decimals** individually sets the decimal elevation precision for each selected surface.

For **File**, either type in the surface name to use or press the **Select** button to choose the surface file from a browse window.

**Load Pre-Calc** allows you to select grid files from a list of grids stored in a Pre-Calculated file (.PRE). These files can be created in the Carlson Mining module.

**Clear**: Clears all values.

**Load**: Loads a Surface Inspector File (.SIF).

**Save**: Saves all settings to a Surface Inspector File (.SIF).

After you fill out the dialog box, click OK. Surface Inspector will load the surfaces and begin showing you real-time elevations for each surface as you move the cursor on the screen. If you pick a point or enter coordinates, the elevation will be labeled along with the surface name and selected symbol as shown below.

**Pulldown Menu Location**: Surface

**Keyboard Command**: surfvals

**Prerequisite**: Surface Model(s)

### Surface 3D FlyOver

This command allows you to view a 3D surface in a simulated drive over or fly over mode. You have the option of following a predefined path such as a road centerline (3D Polyline to follow) or using a user-guided path (free flight). The surface to view can be defined with either screen entities, surface files, or both. The routine offers options for different types of surface shading, direction of travel, viewpoints, vehicles, reference surfaces, light position, color schemes, vertical exaggeration and more.
**Surface Source:** There are two methods of defining the surface to view; "Screen Entities" and "Grid or TIN file". When using the "Screen Entities" option, you must use a 3D polyline to define the path of travel across the surface. Press the "Select Entities" button to select the objects that will define the surface. Eligible surface entities are lines, polylines, 3d polylines, 3D faces, etc. The surface is defined by the selected 3D Faces. The other entities are just for reference in the 3D view.

When using the "Grid or TIN file" method, the surface is defined with either a triangulation file (.FLT or .TIN) or a grid file (.GRD). In addition to the surface file, screen entities may also be selected to be displayed with the surface file. To select the screen entities, press the Select Entities button. With this option, you have the choice of following a 3d poly or free flight.

**Direction Control:** This setting determines how the path of travel is defined on the subject surface.

**3d Polyline to follow:** If you choose the polyline method, then the animation is limited to following the polyline.

**Free Flight:** This option allows the user to randomly navigate the site, but a starting direction must be defined by picking two points on the screen. Once travel starts, the direction can be controlled with either the right and left arrow icons below the window, or with the arrow keys on the keyboard.

**Select Entities:** This must be used for the selection of screen entities when the Surface Source is set to Screen Entities. It can also be used to select additional entities when the surface is defined from file.

**Reference TIN:** This loads an optional second surface file (.GRD, .TIN, or .FLT) in the background to report the cut/fill difference between the given surfaces at the current position. This option is only available when the Surface Source is set to Grid or TIN file.

**3D Texture Image:** This option allows you to drape an aerial image on the surface. This image must be a geo-referenced TIF image that overlaps the area of the surface model.

After making the above selections, the 3D graphics window is opened. The main window displays the drive simulation. The smaller window to the upper right shows the overall plan view and the location of the vehicle of the surface. The middle right window displays the current station (when 3d poly is used for direction control), elevation, slope (in relation to the direction of travel) and azimuth. The 3rd window at lower right indicates amount of roll or cross slope (in relation to the direction of travel) at your current position.
**View Direction:** This determines the direction that you look out of the vehicle based on the direction of travel. This setting does not change the direction of travel. There are four different view directions; front, back, left and right.

**View Position:** This determines the relative position of the viewpoint in relation to the vehicle. There are three different view positions; driver, pedestrian and bird. The driver position puts you inside of the simulated vehicle. Note: The Vehicle Icon option is not available when Driver is used. The Pedestrian position puts you behind and above the vehicle when view direction is set to front, above and to the left when the view direction is right, and so on. The Bird position puts you further behind and higher above the selected vehicle.

**Vehicle Icon:** Determines the type of vehicle to be used in the display. There are nineteen options available, including CAT D11 and D8 Dozers, Hummer, Land Rover, ambulance, and others. You also have the option to not display a vehicle (none).

**Shading:** Determines the type of shading to be applied to the surface when the surface source is from a file. This option is not active when the surface is defined by screen entities. There are four shading options; None, Flat, Smooth and Elevation. The *None* option will not produce shading. The Flat option will use one color per 3d face. The Smooth option blends colors together. The Elevation option generates colors based on the vertical position of the surface entities.

**Surface Color:** This setting will determine the color of surface entities when the shading mode is set to either flat or smooth. The color functions are only available when the Surface Source is defined by a file. If the Surface Source is defined by screen entities, color is determined by the properties of the screen entities.

**High Color:** When using the "Elevation" mode of shading, this sets the color of surface entities that are in the higher elevation ranges of the surface.

**Low Color:** When using the "Elevation" mode of shading, this sets the color for the surface entities in the lower elevation ranges of the surface.
Elevation: This determines the height of the viewer vantage point above the surface. Clicking the up arrow will elevate further from the surface; clicking the down arrow will take you closer to the surface. The arrow keys on the keyboard will also control the elevation.

Distance: This determines the horizontal distance from the viewers vantage point (behind) to the actual focal point on the surface. Clicking the up arrow beside the window will increase the distance from the focal point; clicking the down arrow will decrease the distance.

Speed: This determines the rate of travel across the surface in mph. Clicking the up arrow beside the window will increase speed; clicking the down arrow will decrease speed.

Vertical Scale: This option allows the user to specify a vertical exaggeration factor to aid in viewing flat surfaces with little relief.

Ignore Zero Elevation: Ignores zero elevation entities in the scene.

Apply Texture: Uses a texture pattern for shading surfaces.

Display Sky: Creates a sky dome of 3D faces around the site that is colored blue with some clouds. In order to see the sky, your view point must be below the sky dome. This feature is only available when the software-only graphics mode is turned off under Carlson Configure->General Settings.

Display Trail: Displays the traveled route on the surface as a line.

Display Cut/Fill: This displays real-time the amount of cut or fill at the location of the vehicle. This option is only available when a reference TIN is used in the first setup dialog.

When using "Free Flight", this icon turns the direction of travel to the left.

When using "Free Flight", this icon turns the direction of travel to the right.

Starts the animation in the main window. While running, this button becomes the Stop button.

Stops the animation. When stopped, this button becomes the Run button.

When using a 3D poly for the travel direction, this button returns you back to the original starting position.

The simulation must be in the stopped mode for this to be active. When using a 3D poly for the travel direction, this button will reverse the direction of travel at the current position. The simulation must be in the stopped mode for this to be active.

Converts the left mouse button to a zoom function.
Rotates the main animation window in any X, Y or Z direction by holding down the left mouse button.

Converts the left mouse button to a pan function. Holding down the mouse scroll wheel will also pan.

Toggles shading on and off. This is only active when the surface has been defined with screen entities.

Exits the 3D Surface FlyOver command

Control for position of the light source, viewed from above.

**Pulldown Menu Location:** Surface >> 3D Views  
**Prerequisite:** Surface Model (screen entities or file) and optionally a 3D Polyline  
**Keyboard Command:** flyby

---

**Surface 3D Viewer**

This command reads directly from any surface model file (.TIN, .FLT or .GRD) allowing dynamic 3D viewing without needing any entities in the drawing representing the surface.

Once a file is selected and the Surface 3D Viewer starts, the easiest way to manipulate the viewing angle is with the mouse. Placing the cursor within the surface area and dragging in any direction adjusts the angle of the surface, pivoting about the X and Y axes. Placing the cursor outside the surface and dragging adjust the location of the camera relative to the surface, pivoting about the Z axis. These parameters can also be controlled through various controls on the View Control tab.
**Ignore Zero Elv:** Ignores any surface data at elevation 0.

**Color by Elevation:** Applies a colorization to the surface based on elevation ranges.

**Vertical Scale:** This option allows you to specify a vertical exaggeration factor to aid in viewing flat surfaces with little relief.

Control for position of the light source, viewed from above.

Zooms in.

Zooms out.

Zoom in/out by dragging left mouse button.

Rotates the main animation window in any X, Y or Z direction by holding down the left mouse button.

Converts the left mouse button to a pan function. Holding down the mouse scroll wheel will also pan.

Toggles shading on and off. This is only active when the surface has been defined with screen entities.

Pick mode. Pick on model to list elevation.

Restores plan view.
Rotation axes sliders. Exits the Surface 3D Viewer

Advanced tab:

Block model objects and layers are only used in the Carlson Mining applications.

Shading mode refers to which side of 3D Faces are shaded.

Sets the drawing editor to the same viewpoint as currently displayed in the Surface 3D Viewer. Saves the current view as an image file.

Saves named views. Type a view name and pick Save. Pick saved views from list and pick Set to restore to viewer.

Clip Plane: Adjust slider to clip viewing plane.

Pulldown Menu Location: Surface >> 3D Views
Prerequisite: Surface Model file (.TIN, .FLT or .GRD)
Keyboard Command: cube_surface
Render, Shade, and Hide Commands

The Render, Shade, and Hide commands located under the Surface >> 3D Views menu simply execute the appropriate standard AutoCAD commands.

Pulldown Menu Location: Surface > 3D Views
Keyboard Command: render, shade, or hide
Prerequisite: none

Elevation Zone Analysis

This command can be used to calculate the surface area of a surface in different elevation zone ranges and to analyze a surface by ranges or “zones” of elevation. The program requires 3D Face entities that can be generated by the Draw 3D Grid File command. The Draw Triangulation Faces option in Triangulate & Contour or Draw Triangular Mesh routine under Surface >> Draw Surfaces menu can also be used to create triangular 3D Faces. For each elevation zone, the 3D Faces can be hatched with a hatching pattern, solid filled with the SOLID pattern, or left empty with the NONE pattern. The 3D Faces are also placed in a separate layer for each zone.

In the options dialog, the Property Represented By Z Value sets the name used in the reports for the type of surface model. Label Average In Each Grid Cell creates text labels in the center of each 3D Face of the surface with the average surface value. Subdivide Grid Cells at Zone Boundaries gives higher resolution at the transition between zones. Use Report Formatter allows for customized report and different output formats.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the area within the inclusion polyline is calculated. Areas within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the area of each selected 3D Face is used.
Prompts

Elevation Zone Analysis dialog
Select 3D Faces to Analyze...
Select objects: pick the 3D Faces to process

Define Ranges (Lowest to Highest) Dialog
Specify the elevation ranges, colors and patterns.
Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Select point for color legend (Enter for none): pick a point
If a point is picked, a legend showing the color of each range is drawn. The legend is drawn aligned to the current view UCS. For this reason it is best to have the mesh at the Vpoint at which it will be plotted before executing the analysis program.

A report is also generated in the standard report viewer.
Result of Elevation Zone Analysis viewed in 3D and shaded

**Pulldown Menu Location:** Surface  
**Keyboard Command:** elvzone  
**Prerequisite:** displayed 3D Face entities.

---

**Slope Report**

This command calculates the sloped surface area, average slope and average elevation on a site. The surface can be defined by a surface model file, (.GRD, .TIN or .FLT), or generated from 3D entities on the screen. Sloped area information is useful to compute seeding quantities for hillsides, for example.

For the screen method, the surface is modeled from the user-selected entities such as contour polylines. Besides the surface entities, a perimeter polyline is used as the inclusion area for the slope report. If the perimeter polyline is on the PERIMETER layer, the command will locate it automatically.

For area reports, there are options to specify inclusion and exclusion perimeters. When inclusion perimeters are
specified, only the area within the inclusion perimeters is calculated. The area within exclusion perimeters is not included in the calculations. Inclusion and exclusion perimeters are represented by closed polylines and must be drawn prior to running this routine.

**Prompts**

For Area report using a File:
**Slope report by area or two points [Area/<Points>]? A for Area**
Source of surface model (<File>/Screen)? F for File
Select surface model file.
**Select the Inclusion perimeter polylines or ENTER for none:** pick any inclusion polylines
**Select the Exclusion perimeter polylines or ENTER for none:** pick any exclusion polylines
Note: If the surface model file is a grid file (.GRD), you are prompted whether to extrapolate the grid to full grid size.

![Screen Capture](image.png)

For Area report by Screen method:
**Slope report by area or two points [Area/<Points>]? A for Area**
Source of surface model (<File>/Screen)? S for Screen
Ignore zero elevations (<Yes>/No)? press Enter
Select surface entities and perimeter.
**Select objects:** pick the objects
If no polyline is found on layer PERIMETER, you are prompted to: Select Pond/Pit perimeter polyline.
The Make 3D Grid File dialog is presented. Pick OK.

![Make 3D Grid File](image.png)

**Select the Inclusion perimeter polylines or ENTER for none:** pick any inclusion polylines
**Select the Exclusion perimeter polylines or ENTER for none:** pick any exclusion polylines
For Points method:

**Slope report by area or two points [Area/<Points>]? P for Points**

Select surface model file.

**Pick first point:**

**Pick Second point:**

The slope report is displayed on the command line for the 3D vector, projected on the surface, defined by those 2 picks.

Point 1: 5119.646,5640.322,98.979
Point 2: 4951.964,6022.419,135.546
Horiz Dist: 417.27 Slope Dist: 418.87 Elv Diff: 36.57
Slope: 8.76 Ratio: 11.41:1

**Pulldown Menu Location:** Surface >> Slope Analysis

**Keyboard Command:** sarea

**Prerequisite:** A surface file or screen entities of the surface.

---

**Slope At Points**

This command labels the slope percent at user Screen Picked points or Surface Points. Surface Points can work well on grid files, (.GRD), but is typically too much information for triangulated surface files (.TIN or .FLT).

The slope is computed from the surface model file (.TIN, .GRD, or .FLT).

As the crosshairs are moved across the surface, the slope at the current position is displayed in a floating dialog box.

![Slopes At Points](image)

7.45%

In addition to labeling the slope value at the user specified points, a Leader Arrow can be drawn in either the uphill or downhill direction. The dialog also allows you to specify Label Prefixes and/or Suffixes, Decimal Precision, and Slope Format.
The Set Layer/Size/Color By Slope Ranges option invokes the Define Ranges dialog box. Enter slope values in the first column of boxes to set the Ranges.

Prompts

Slope At Points dialog box
Adjust settings as desired. Pick OK.

Select Surface Model.

Pick Points to label slope.

---

Pulldown Menu Location: Surface >> Slope Analysis

Keyboard Command: ptslope

Prerequisite: A surface model file (.TIN, .GRD, or .FLT)

---

**Slope Zone Analysis**

This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), or 3D Face drawing entities, which can be generated by the **Plot 3D Grid File** command, the **Draw Triangular Mesh** command, or the Draw Triangulation Faces option of **Triangulate & Contour**. For each slope zone, the 3D Faces can be hatched with any hatch pattern, including the SOLID pattern, or left empty with the NONE pattern. The command reports the area for each slope zone. The Use Report Formatter option allows for customized reports and different output formats.
This command can also generate contours of the slope zones based on the calculated slope at each point of the 3D Faces. The slopes can vary greatly between neighboring points. When contoured directly, these slope data points produce incoherent contours. Instead this routine applies a filtering algorithm that reduces the noise. There is another option to output a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

**Prompts**

**Source of surface model:** [File/<Screen>]? F for File

**Slope Zone Options dialog box.** Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick **OK**

**Select surface model file.**

**Define Ranges dialog.** Specify the slope zones, colors and patterns from lowest to highest. Pick **OK**.

**Select the Inclusion perimeter polylines or ENTER for none:** select perimeter(s) or press Enter

**Select the Exclusion perimeter polylines or ENTER for none:** select perimeter(s) or press Enter

Report is generated.

If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented.
Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to:

**Apply hatch patterns to grid cells [Yes/<No>]?** and

**Freeze grid layer after processing [Yes/<No>]?**

Surface contours

3D Faces from a grid surface model
3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option

Slope zone contours

Slope zones that follow the surface contours using the triangulation 3D Faces
Hatched slope zone contours created from the grid 3D Fac

**Pulldown Menu Location:** Surface >> Slope Analysis  
**Keyboard Command:** szone  
**Prerequisite:** Surface model file (.TIN, .GRD, or .FLT), or 3D Faces entities

### Slope Direction Analysis

This command categorizes the slope direction as either N, NE, E, SE, S, SW, W or NW. The program requires 3D Face entities that can be generated by the Draw 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. Each 3D Face is colored by the slope direction zone and a report of the area for each zone is generated. A pinwheel color legend can also be drawn.

There are options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

### Prompts
Select 3D Faces to Analyze...
**Select objects:** *pick the 3D faces*

**Slope Direction Colors** Choose a color for each direction.
**Select the Inclusion perimeter polylines or ENTER for none:**
**Select objects:** *Pick a closed polyline if needed*

**Select the Exclusion perimeter polylines or ENTER for none:**
**Select objects:** *Pick a closed polyline if needed*

**Select point for color legend:** *pick a point*
Convert LDD Contours

This command allows you to convert Autodesk Land Desktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the object enabler installed, download the latest version from http://www.autodesk.com.

Note: If no object enabler is installed, opening a Land Desktop drawing with contours will display large boxes for each contour, essentially outlining the extents of each one. In this case you will need to download the object enabler. If the object enabler is installed, contours will appear normally, and you can use this command to convert them to standard lwpolylines or you can use the Explode command. The Carlson Convert LDD Contours command is preferable only in the fact that it will search the drawing for AECC_CONTOUR objects and convert only those, while an Explode command could inadvertently explode other entities that you do not wish to be exploded.
You can use the *List* command to determine if contours are polylines or AECC_CONTOUR objects. Here is an example listing:

**AECC_CONTOUR**

Layer: "CONT-MJR"
Space: Model space
Handle = 429
Major Contour Interval
Elevation: 1005.00
Smoothing: None
Number of Vertices: 48
Open
Length: 560.25
Constant width: 0.00
Style Name: Standard

**Prompts**

*Select AEC Contours to convert*
*Select objects: pick the AEC contour entities*

**Select LDT/Civil3D Drawing To Read** Pick .dwg file to load
**Select Converted Drawing To Write** Set .dwg file to create

**Prompts**

*Select LDT/Civil3D Drawing To Read* Pick .dwg file to load
*Select Converted Drawing To Write* Set .dwg file to create

---

**Convert LDT/Civil3D Surface Drawing**

This command allows you to convert Autodesk Civil3D or Land Desktop custom surface objects into standard AutoCAD entities. For example, this command will convert AECC_CONTOUR objects into polylines with elevation. The conversion is done by loading a .dwg file, converting the custom objects and then saving as a new .dwg file. The .dwg file to convert should not be currently opened. The conversion routine was developed by the Open Design Alliance (ODA) and does not use object enablers from Autodesk.

**Prompts**

*Select LDT/Civil3D Drawing To Read* Pick .dwg file to load
*Select Converted Drawing To Write* Set .dwg file to create

---

**Import Google Earth Surface**

In addition to providing a graphical method for displaying feature-rich data located anywhere on the globe, Google Earth also provides the ability for software applications to extract its underlying terrain data. While the elevational accuracy of the Google Earth surface should be considered extremely coarse, it might be suitable for large-scale watershed modeling studies, preliminary land-planning studies or "proof-of-concept" preliminary designs.

When extracting terrain data from Google Earth, it is important to keep "diminishing returns" in mind. As an example, a land surveyor might perform a traditional grid-based topographic survey by sampling the land every 50 feet. Although a 25 foot grid spacing would yield more accurate results than a 50 foot grid, it would typically take at least twice as long to survey. Harvesting terrain data from Google Earth operates in a similar fashion:

1. The Google Earth "project area" is identified and the limits of the site are calculated
2. Horizontal and vertical "sample" intervals are established
3. Terrain data is gathered at each identified sample location and used to form a surface model
Consider the following example. Based on the physical screen size of the Google Earth application and the "zoom" (or "view") resolution of a project site, the following values (summarized at the bottom of the dialog box) were returned:

<table>
<thead>
<tr>
<th>Unit</th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feet</td>
<td>1637</td>
<td>966</td>
</tr>
<tr>
<td>Pixels</td>
<td>1366</td>
<td>809</td>
</tr>
<tr>
<td>Feet/Pixel</td>
<td>1.19</td>
<td>1.19</td>
</tr>
</tbody>
</table>

In the sample above, the total area is calculated and displayed (0.1 mi²) along with the desired "projection" system for our project site. Although it might be desired to sample every pixel in this project... $1,107,270 = (1366+1)*(809+1)$, in all, the "point of diminishing return" would be quickly reached and could clog Google servers with extraneous terrain requests; see the NOTE section below.

**Spatial Reference**: Displays the spatial reference coordinate projection system of the current drawing. The projection can be set using the Drawing Setup command.

**Extent - Current Google Earth View**: Gets the overall dimensions of the Google Earth session and displays the results in both pixels and the appropriate units of measure.

**Extent - Current Drawing View**: Gets the overall dimensions of the current CAD view and displays the results in both pixels and the appropriate units of measure.

**Extent - Select from Drawing**: Sets the overall dimensions of the Google Earth session to conform with a drawing window from CAD and displays the results in both pixels and the appropriate units of measure.

**Pixel Sampling Interval**: Allows the ability to indicate how often a pixel row or column should be sampled for terrain elevation. Smaller intervals result in higher total samples and longer processing time.

Consider the following "sample" diagram:
Referring back to our horizontal and vertical samples shown in the dialog box above, we are requesting:

<table>
<thead>
<tr>
<th>Requesting</th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pixel Interval</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>Samples</td>
<td>$92 = \text{Int}(1366/15)+1$</td>
<td>$54 = \text{Int}(809/15)+1$</td>
</tr>
<tr>
<td>Sample Every</td>
<td>$17 \text{ ft (approx.)} = \text{Int}(1637/92)$</td>
<td>$17 \text{ ft (approx.)} = \text{Int}(966/54)$</td>
</tr>
</tbody>
</table>

Google Earth Sampling

The resulting total samples $4968 = (92) \times (54)$ and it is recommended that this value be at or below the Google Earth session threshold of 5000.

Note:

- In an effort to protect their servers from abuse, Google will rapidly return 5,000 sample requests per Google Earth session and then "throttle down" the remaining sample requests to about 1 per second. In the example above but with a sample interval of 1H and 1V, the terrain surface would be completed in a little over 12 days, 18 hours. For this reason, it is strongly suggested that the horizontal and vertical sampling intervals be set so that the sample result is at or below the 5000 sample threshold.
- The Import Google Earth Surface routine fetches terrain data in real-time from the Google servers and requires an Internet connection to proceed. In the event that an Internet connection is not available, the following error message may be displayed: "Failed to initialize Google Earth. Please ensure Google Earth client software is functional and online"
- It bears repeating that the terrain data returned by Google Earth should only be used for illustrative or proof-of-concept purposes only!
- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

Prompts

**Identify first corner:** Identify one corner of a drawing window that should be used to set the Google Earth display

**Identify opposite corner:** Identify the opposite corner of a drawing window that should be used to set the Google Earth display

**Pulldown Menu Location:** Civil > Surface > Import/Export Surface, Survey > Surface > Import/Export Surface, Takeoff > Tools > Import/Export, Construction > Import/Export

**Keyboard Command:** gesurface

**Prerequisite:** Coordinate projection system, Functioning version of Google Earth with Terrain enabled, Internet connection
Import/Export Trimble TTM File

These commands convert between Trimble TTM format triangulation files and Carlson format. First you select the
source file to read and then the destination file to write.

**Pull-down Menu Location:** Surface->Import/Export Surface
**Keyboard Command:** ttm2tin, tin2ttm
**Prerequisite:** File to convert

Export Topcon TIN File

The Export Topcon TIN File command writes a Topcon TIN file (.TN3) from a Carlson triangulation file (.TIN, .FLT). The routine first prompts for the Carlson file and then the Topcon file.

The Import Topcon TIN File command creates a Carlson Tin file (.TIN, .FLT) from a Topcon triangulation file (.TN3). The routine first prompts for the Topcon file and then the Carlson file.

The units (Feet or Meters) for the triangulation file are the current units set in Drawing Setup.

**Pull-down Menu Location:** Surface > Import/Export Surface
**Keyboard Command:** topcon_tin, tn3_to_tin
**Prerequisite:** A triangulation file

SiteNet Menu

The SiteNet programs build triangulation surfaces, apply surface adjustments, calculate volumes and report material
quantities. Drawing layers are organized by target surfaces: design, existing or other. Polyline perimeters are used
to define the site boundary, subgrade areas and topsoil areas. Once the layers and perimeters are setup, the surfaces
are created by the Make Existing/Design Surface commands. Then there are commands to inspect the surfaces and
report volumes and material quantities. See the Takeoff chapter of the manual for specifics on each command.
Centerline Menu

The Centerline menu provides commands for designing and editing centerlines and centerline files. Tools for stationing, labeling and offsetting centerlines, along with Right of Way features, are also provided in this menu. Additionally, there are many import and export conversion options to select from when you pick Centerline Conversion.

Design Centerline

This command draws a centerline polyline and writes the centerline data in a centerline file. The first step is to specify a centerline (.CL) file name. Next in the Design Centerline dialog you can specify several options. Centerline Layer is the layer name for the polyline. Tangents Layer is the layer name for the tangent lines drawn from the centerline to the curve center. Max superelevation is used for determining the minimum recommended radius. Setting the Prompting mode to Existing skips design questions such as design speed.

After the Design Centerline dialog, the program cycles through curve prompting until End is selected. There are PC and PI modes for curve entry. In PC mode the arc's PC points are entered followed by the curve data. The PC points can be specified by either picking the point, entering a distance or entering a station. In PI mode, the arc's PI points are entered. Once the PI points determine two tangents, the program prompts for curve data for the previous PI. Spirals can only be entered in PI mode. You can switch between arc and PI mode between curves on the polyline. The arc curvature can be specified by degree of curve or radius. The minimum recommend radius is based on AASHTO. The arc length can be specified by PT station, tangent length or arc length.

The Store Points in CRD File will create points in the current coordinate file for each design point on the centerline. This option is also used for creating the SMI chain file within Centerline Utilities, since the SMI chain file requires point numbers. To specify the coordinate file, choose Set Coordinate File in the Points menu.
Prompts

Centerline file to design Enter the .CL file name to create.
Design Centerline Dialog Choose your options and click OK.
Pick Point or Point number: pick a starting point or enter the starting point coordinates
For PC mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pick the PC point
Bearing/PC/PI/End/Undo/<Pick Point or Point number>: PC
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter for right
Length to use (Station/Tangent/<Arc>)? press Enter for arc
Point/Station/Tangent/<Arc Length>: 200
Reverse/Compound Curve (Yes/<No>)? press Enter
PI/Distance/Station/<Pick PC or Point number>: D for distance
Point/Enter Distance: 180
Bearing/Line/Undo/End/<Continue PC>: press Enter
Enter Design Speed for curve <40.00>: press Enter
Minimum Recommended Radius = 426.67

Example of PC mode centerline design
Example of PI mode centerline design

Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Bearing/Pick next Point or Point number (PI): pick the last PI
PC : 9+35.900
PT : 16+34.283
Reverse/Compound Curve [Yes/<No>]: press Enter
Bearing/Line/PC/Undo/End/<Continue PI>: E to end
EndPoint : 18+37.121

Stations are printed for every PC, PT and end point in the design process.
**Input-Edit Centerline File**

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc.). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.

---

**Drag Action (Zoom and Pan):** In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

**Zoom Drawing To Current Segment:** This option zooms the drawing graphics to center on the centerline segment currently highlighted in the dialog.

**Hold Other PI Points When Change Starting Point:** With this option active, all the existing PI's are held when the starting coordinate is moved. Otherwise, all the PI's are moved by the same amount that the starting point is moved.

**Show Right of Way:** This option shows any ROW's defined in the centerline in the graphic preview window.

**Type of Curves:** This setting chooses between roadway and railroad definitions for curve lengths.

**Add:** Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.
Edit: Allows you to edit the highlighted segment.

Remove: Removes the highlighted element from the centerline.

Up/Down: Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45d NE, moving the last element up would create a line at 45d after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45d.

Load: Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

Screen Pick: Allows user to pick a CL off the screen in the drawing to load into the editor.

Tools > Reverse: Reverses direction of Centerline.

Tools > Rotate: Rotates the centerline by the specified rotation angle and around the specified pivot point.

Draw: This button draws the centerline in the drawing on the specified layer.

Save: Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

SaveAs: Prompts you for a file name for the saved file.

Fit Curve: Fits a circular curve element into the centerline after the line element that is currently selected.

Fit Spiral: Fits a spiral curve element into the centerline after the line element that is currently selected.
**Point Numbers:** This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

**Station Equations:** At any number of locations on a centerline, you can set the back station and forward station for the re-stationing of the centerline. The station equation dialog appears below:

If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

**ROW:** This function edits the right-of-way definitions associated with the centerline. There can be multiple ROW's assigned to the centerline for left and right sides as well as multiple on the same side. The function first shows a list of ROW's for the centerline where you can add, edit or delete.
When you add or edit a ROW, there is a second dialog for entering the stations and offsets that define the ROW relative to the centerline. Use negative offsets for left and positive for right.

Alternatively, the **Enter Right of Way** and **Polyline to Right of Way** commands are other ways to define the ROW’s for a centerline.

**Exit:** Exits this routine, prompting to save changes if necessary.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

- Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.
- When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.
- All bearings should be specified by entering the angle between 0 and 90 degrees (in dd.mmss format) and selecting the quadrant.
- When entering the delta angle of a curve, only the absolute value (between 0 and 360 degrees) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.
- Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to
be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length. The other parameters of the curve that can be edited are the bearing of tangent-out and the "Station to", which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right). The Spiral Definition setting chooses between Arc definition for clothoid spirals and Chord for 10-chord spirals.

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results. You can spiral from tangent to curve, curve to tangent and curve of one radius to curve of another radius. You can also spiral from one endpoint to another endpoint. To define the spiral by sweep angle, use the Delta Angle field. To define the spiral by length, use the Spiral Length field. To define the spiral by end point, fill in the min and max radius fields and then enter either the End Point Pnt# or coordinates and the program will calculate the radius and spiral length to fit that point.
Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only):

**Line (Tangent) Segment:** We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element
can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.

**Spiral Segment:** Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, and (3) the tangent-out bearing. Everything else will calculate when you press Enter for the PI station.

**Curve Segment:** Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius
Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

**Final Line Segment:** All you need to enter in the final dialog for the line (tangent) segment is its length. All other items will calculate when you press Enter.

The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
Pulldown Menu Location(s): Centerline (Survey, Civil), Roads (Construction, Takeoff)

Keyboard Command: cedit

Prerequisite: - None -

**Polyline to Centerline File**

This command writes a centerline (.CL) file from a polyline in the direction the polyline was drawn. The Northing and Easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve. After selecting the polyline, the program shows the direction by drawing temporary arrows along the polyline. To reverse the direction of the polyline, there is a keyword option R for Reverse at the Command line. Also, the Reverse Polyline command can be used to switch the direction of a polyline.

For stationing the centerline, there is a Command line prompt for entering the station at the beginning of the polyline and then using the polyline segment lengths for the rest of the centerline stations. Alternatively, there is a keyword option E for Ending to specify the station at the end of the polyline and then back calculating the centerline stations to the beginning using the polyline lengths.
In addition to being used as roadway/corridor "baselines," a .CL file can also be used as the horizontal control for a Template Point Centerline.

Note: To convert lines and/or arcs into a polyline, use the Entities to Polylines command or the Join Nearest command.

**Prompts**

**Centerline file to Write dialog** Enter the .CL file name to create

**Centerline station [Reverse/Ending/<Beginning: 0+00>]:** Press Enter to accept the default station value specified or Type in the beginning station then press Enter

**Select polyline that represents centerline:** Pick the polyline that represents your centerline

**Pulldown Menu Location(s):** Civil > Centerline, Survey > Centerline, Field > Roads

**Keyboard Command:** clpline

**Prerequisite:** A polyline drawn in the direction of increasing station values.

**Edit Centerline On-Screen**

This command allows the graphical editing of a centerline on the screen through a combination of grip editing and data editing in a docked dialog.

The command initially prompts you to select a polyline on the screen.

If you select a polyline that is not yet associated with a centerline file (.CL), you are prompted to assign a centerline file (.CL) to the polyline or to select another polyline.

Once the docked dialog appears, any component of the centerline geometry can be selected in the list and its data edited with the Edit button. However, the key points on the centerline can also simply be grip edited in the drawing.
resulting in changes in the tabular data displayed in the docked dialog. Tangency between centerline components is maintained.

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** clgrip  
**Prerequisite:** A polyline on the screen, which can either be already associated with a centerline file (.CL) or associated after picking

---

### Draw Centerline File

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an option to specify whether to draw PI lines and specify their length. The Label Centerline option draws station labels using a .STA settings file created by the Save Settings function in the Station Polyline/Centerline command.

Next you are prompted for the file name of the centerline to plot.

The .CL file can be made with the following commands on the Design menu: *Polyline to CL File, Input-Edit Centerline* or *Design Centerline*. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

---

### Prompts

**Draw Centerline Options dialog**

**Centerline File to Draw file selection dialog** Select the .CL file name to read and plot.

---

### Centerline Report

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. The options dialog has settings for the report format and type of the centerline. The Use Profile for Elevations Report option will prompt you for a profile (.pro) file to add elevations to the report. The Report At Interval option will report stations, northing and easting at the specified station interval. The Use Report Formatter option lets you choose the report format and has output options for Excel.
Here is an example report:

Centerline Report
Centerline File: C:samplesetback_3.cl

Station Northing Easting Bearing Distance
0+00.000 4033.165 4379.271
N 13°07'20'' W 92.076'
0+92.076 4122.836 4358.367 PC
Radius: 4196.621 4674.880 Radius Length: 325.000'
PI: 4159.044 4349.926 1+29.254 Tangent: 37.178'
Arc Len: 74.035' Delta: 13°03'07'' Right Degree: 17°37'46''
Chord Len: 73.875' Chord Brg: N 06°35'47'' W
Radial-In: N 76°52'40'' E Radial-Out: N 89°55'47'' E
Tangential-In Tangential-Out
1+66.110 4196.222 4349.881 PT

Pulldown Menu Location: Centerline
Keyboard Command: clreport
Prerequisite: A centerline (.CL) file

Centerline ID
Centerline ID reports the centerline file name and location that is associated with an alignment polyline. The subject polyline must have been created with either Design Centerline, Input/Edit Centerline, or Polyline to Centerline File. When the routine is initiated and an alignment polyline is selected, the file associated with that polyline is reported at the command line. Additional alignment polylines may be selected without re-entering the command, or Enter may be pressed to exit the command.

Prompts

Select centerline polyline to identify: pick the polyline
Centerline Name: D:samplesample.CL
Select centerline polyline to identify (Enter to end): press Enter

Pulldown Menu Location: Centerline
Keyboard Command: CL_ID
Prerequisite: A polyline created from a Design Centerline, Input/Edit Centerline, Polyline to Centerline File, or...
Centerline File to Polyline.

Station Polyline/Centerline
This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.

Distance for Stations is the primary interval for stationing. On Curve allows for a different interval for curve segments verses line segments.

Distance for Intermediate Stations is the intermediate interval for stationing. On Curve allows for a different interval for curve segments verses line segments.

Beginning Station is the beginning station of the centerline for stationing.
Locate Even Stations labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).
Locate Odd Stations labels the non-interval stations at the polyline/centerline end points and PC and PT points.
Locate User-Entered prompts you for individual stations to label.

Without the Increment Station Labels from Beginning Station option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

Label Deflection Angles adds this annotation to the stationing. Settings for this are specified in the Label Deflections Setup, accessed by the Deflections Setup button.
When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **PC/Spiral Setup** button accesses the **PC/Spiral Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the centerline as well as for the spiral special stations (TS, SC, CS, ST).

**Draw PC Lines** controls whether lines are drawn from the PC and PT points.

When **Label PC On Centerline** is checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.

**Draw PC Symbols** controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the box to the right.
Label PC Radius controls whether this point is labeled.
Max Length controls the maximum length for the PC lines to be drawn described above.

Back in the main Station Polyline/Centerline dialog box:

Draw PI Lines draws a 2 segment polyline in both tangent directions from the PI as a marker for the PI.

When Label PI Stations is checked, the PI station is labeled at the PI point.

When Locate PI Points is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When Label Station Text is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection. Select it to configure the label settings as desired. Select the Marker Setup options to modify the size of the markers for certain types of stations. See definitions following the dialog box.

Also under PC/Spiral Setup is Curve Table Setup which controls whether to draw data tables for the curves and spirals. When this option is on, the program creates a data table with the selected fields for each curve and automatically places each table to the outside of the curve.
Label Setup

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.
- **Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.
- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.
- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.
- If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.
- **Label Intermediate Stations**: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.
- **Station + at Tick Mark** labels the station text along the polyline with the '+' of the station text at the station's location on the polyline. See Marker Set up for marker size manipulation settings.
- **Horizontal Offset** shifts the station label along the centerline.
- **Station Prefix** adds to the front of the station labels.
- **Remove Zeros** removes the specified number of least significant digits from the station label if these digits are all zero.
- **Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.
- **Use Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.
- **Specify the Position** of the station labels, either above or below the centerline. This is only available when
labeling stations using the parallel option.

- **Align** determines the alignment of the station label, either left or centerline, centered along the centerline or to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The **Marker Setup** options control the size of markers for different station types as well as the layer the markers will be drawn on. The Half Size Main options draw a perpendicular tick mark on only one side of the centerline. Otherwise a full marker is drawn that goes of both sides of the centerline. There are separate Half Size options for the main station interval, intermediate station interval and odd stations.

![Marker Setup dialog box](image)

Specify whether to define the **Centerline By** picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- Using a **2D Polyline** will result in horizontal distance stationing along the polyline.
- Using a **3D Polyline** will result in the slope distance stationing along the polyline.
- Using a **Profile Polyline** uses a polyline on a profile grid where the X coordinate represents the station and the Y coordinate represents the elevation. The station labels will use the distance along this profile polyline.
- Using a **CL File** will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.

Use **Station Type** to specify the stationing format to use.

Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CooRDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

**Vertical Exaggeration** applies to Profile Polyline mode. This factor is the ratio between the horizontal and vertical scales on the profile grid.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.
• The **3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.

• The **Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.

• With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point.

**Description Prefix** is an optional user-specified prefix to be added to the point description.

**Description Suffix** is an optional user-specified suffix to be added to the point description.

When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

- When **Use Slopes** is on, it makes available the Percent Slopes fields for defining the slope from centerline both right and left for determining the elevations of the offset points.

- Enter the desired **Offsets** left and right.

- Enter the desired **Percent Slopes** from centerline to the left and right offset points.

- The **Vertical Offset** is added to the elevation of the offset points.

**Prompts**

**Station Polyline Dialog**

Polyline should have been drawn in direction of increasing stations.

Select polyline that represents centerline: *select a polyline*
Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Labels with Draw PI Lines, Label PI Stations and Locate PI Points all checked on

Labels using Centerline By 2D Polyline (Horizontal Station)

Labels using Centerline By 3D Polyline (Slope Station)

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** stapl  
Prerequisite: A polyline or CL file

**Label Station-Offset**

This command will compute and label the station(s), offset(s) and elevation(s) of a selected point or group of points or entities. Additional labels for the name(s) of the reference alignment(s) and description(s) can also be specified and placed to further annotate the point(s) that are selected.

A common usage for using dual alignments and profiles typically involves the alignment and profile of a road coupled with the alignment and profile of a pipe/utility.
**1st/2nd Alignment:** Specify the criteria for either one or two alignments that will be used for the label(s) that will be placed into the drawing.

**Use 2nd Alignment:** Enable this toggle if multiple alignments are to be used for the label(s) that will be placed into the drawing.

**Name:** Supply a label-friendly value for the name of the alignment (e.g. "King Street" or "Water Main"). The value(s) specified get assigned to the Alignment Label Field.

**Centerline:** Indicate the source (Polyline or Centerline File) for the reference alignment. If the Polyline option is selected, you will be prompted to select the polyline(s) after the OK button is pressed. If CL File option is selected, supply a valid path and filename for the centerline file or navigate to the file using the "File Picker" button shown below. The Beginning Station will be determined from the selected Centerline File.

**Beginning Station:** Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. This control is not used when you use a centerline (.CL) file to define the centerline as the starting station of the centerline is stored in the .CL file.

**Vertical Reference:** Indicate the source (3D Polyline, Profile File or Road Network) for the reference elevation. With 3D Polylines, there will be an additional Slope Station available under the Label Fields in addition to the regular horizontal distance station. If the Profile option is selected, supply a valid path and filename for the profile file or navigate to the file using the "File Picker" button shown above. For the Road Network, specify the road network (.rdn) file with the "File Picker". With the Road Network method, the program will find the road design surface elevation for the specified points using all the road network design files including profiles, templates and transitions.

**Cross Slope (%):** Indicate the slope as a percentage to "travel" from the Vertical Reference. A value of 0 (zero) will not apply any cross slope from the reference elevation. Positive values will decrease the calculated elevation(s) and negative values will increase the calculated elevation(s).

**Vertical Adjustment:** Indicate the desired amount of vertical displacement that should applied to the calculated elevation. This is useful when deriving elevations for back or face of curb.
**Label Alignment:** Specify whether the labels should be Horizontal on the screen, Vertical on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

**Text Size Scaler:** Determines the size of the labels. This value multiplied by the horizontal scale setting in *Drawing Setup* results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the labels will be 10 units.

**Text Style:** Specify the desired text style for the label.

**Leader Segments:** Specify the desired number of leader segments that should be allowed when constructing the label.

**Use Relative Leader:** Indicate whether successive labels placed into the drawing should re-use the geometry of the initial leader placed with the command.

**Draw Leader Arrow:** Indicate whether to draw an arrowhead on the leaders.

**Draw At Fixed Position:** After you pick the first label position, the rest of the labels will be placed at this same level. This option applies to the Vertical and Horizontal Label Alignment methods.

**Label Fields:** Use the green arrow buttons to specify the items that are to appear in the labels. As labels are "moved" from Available to Used, a Label Format dialog box particular to the label will appear that will allow for more precise display control. To subsequently edit each item, use the Format Editor button as shown below.

![Label Format dialog box](image)

**Note:**

- The Row Number value is specified as the row starting closest to the leader with subsequent rows moving further from the leader as shown in the figure below. Row 2 below the leader has been illustrated with the Draw Box option enabled.
Layers: Specify the layer of each item that comprises the label.

Max Offset to Calc: Specify the maximum offset to calculate.

Truncate Station at +: Removes the digits before the + in the station labels.

Station Type: Specify the stationing format to use.

Flip Text for Twist Screen: When this option is enabled, the label(s) will be flipped as necessary to adjust for the use of Twist Screen.

Add to Existing Point Description: When picking points to label by point #, this option appends the label to point description instead of creating a text label. The description is updated both in the coordinate file and for the point description attribute in the drawing.

Type of Curve: Specify whether the centerline is for a roadway or railroad. Stationing for Roadway Curves is measured along the curve length itself whereas stationing for Railroad Curves is measured along chord segments.

Save: Allows the current settings to be saved to a Station-Offset Settings (*.sos) file.

Load: Allows settings from a previously saved Station-Offset Settings (*.sos) file to be recalled for use.

Prompts

Polyline should have been drawn in direction of increasing stations.
Select Polyline Centerline (Alignment-1): Pick the polyline centerline This prompt will not appear if the Centerline File option was specified.
Select 3D Polyline Profile (Alignment-2): Pick the polyline profile This prompt will not appear if the Profile File option was specified.
Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Pick a point
Pick point to label: Pick a leader vertex point
Pick label alignment: Pick angle for the label This prompt will only appear if the Pick option was specified.
Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Press Enter

Real-time display of Station and Offset as you move the cursor.
A sample label with a 2-segment leader.

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** offsta  
**Prerequisite:** A polyline or centerline file.

**Offset Point Entry**  
This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.

![Offset Point Entry dialog box](image)
The **Store Points to Coordinate File** option will store any points the current coordinate (.CRD) file. This includes centerline points and offset points.

When **Locate Points on Centerline** is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When **Label Stations & Offsets** is checked, the program will label the station-offset as the point description attribute.

When **Locate Intersection Points At Line Corners** is checked, the program will locate points along the centerline at the intersection points of selected lines with that of the centerline. This routine is to be used along with Locate Points on Centerline. This is a good option to use when the exact station of where the offset points are to be created is not known but is referenced by an existing line on the drawing.

The **Include Station-Offset In Description** option will add the station and offset of the point into the point description.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use **Centerline from** to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use **Reference Elevation** to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. **Profile to 3D polyline** can be used to transfer the profile data to the polyline before calculating the final grade points.

**Cross Slope %:** This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in **Input Station-Offset from** will prompt for the station and offset distances. The **Read File** option will read the stations and offsets from a text file. The text file format with point number, station, offset, elevation and description. The program handles station formats with or without the '+' (i.e. either 250 or 2+50). The elevation and description are optional. The Read File option is a quick routine to convert a station-offset data file into coordinates. The delimiter for the text file and the order of the fields are set in the dialog shown here.
When Offset Prompt is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value.

Use Station Type to specify the stationing format to use.

Use Type of Curve to specify whether the curves are for a roadway or railroad.

Prompts

Offset Point Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline to Station-Measure: select a polyline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
Distance from beginning station along centerline (Enter to end): 110
Starting Segment Station: 0.0 Ending Segment Station: 228.633
Working Line segment...(5413.4 4879.64 0.0)
Left offset distance < 10.0 >: 15
Right offset distance < 15.0 >: 20
Distance from beginning station along centerline (Enter to end): press Enter

Keyboard Command: offpts
Prerequisite: A centerline (.CL) file, polyline, or two points

Calculate Offsets
This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example).
Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

Maximum Offset to Calc: This is the maximum distance from the Centerline for which offsets are calculated.

Report Offsets Ahead/Behind Centerline: When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

Label Station and Offsets: When checked, the station offsets will be labeled in the drawing.

Sort Report by Stations: When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

Report Point Coordinates: When checked, this option will include the point northing and easting in the report.

Report Point Notes: When checked point notes will be included on the calculate offset report.

Create Point Notes: When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

Use Report Formatter: When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft® Excel or Microsoft® Access. You must check this option on in order to use the Report Grade Elevation From option.
**Round Stations:** When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example, if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.

**Store Station Text to CRD File:** When checked, the station offset text is appended to point numbers that are selected.

**Report Grade Elevation From:** When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To use this option, the *Report Formatter* must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

**Define Centerline by:** Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points. The polyline mode can be either 2D or 3D for horizontal or slope distance stationing.

**Station Type:** Specify the stationing format to use.

**Decimals:** Specify the display precision for the stations and offsets.

**Type of Curve:** Specify whether the curves are for a roadway or railroad.

**Prompts**

**Calculate Offset Settings Dialog**

*Polyline should have been drawn in direction of increasing stations.*

*Select Polyline near endpoint which defines first station.*

[nea on] *Select Polyline Centerline: select polyline centerline*

(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63

PtNo. North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00 Station on Line
141 4870.15 5416.55 0.00 1+10.00R10.00 Station on Line

+ before station denotes point is ahead of line segment, - denotes beyond.

**Pick point or point numbers (Enter to End): 22-28**

<table>
<thead>
<tr>
<th>Station</th>
<th>Offset</th>
<th>Description</th>
<th>Elev</th>
<th>Pt#</th>
<th>North</th>
<th>East</th>
</tr>
</thead>
<tbody>
<tr>
<td>4+95.89L</td>
<td>15.48</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>22</td>
<td>4811.00</td>
<td>4454.00</td>
</tr>
<tr>
<td>5+78.43L</td>
<td>58.18</td>
<td>Power Pole</td>
<td>0.00</td>
<td>23</td>
<td>4839.00</td>
<td>4548.00</td>
</tr>
<tr>
<td>6+77.26L</td>
<td>57.28</td>
<td>Power Pole</td>
<td>0.00</td>
<td>24</td>
<td>4868.00</td>
<td>4656.00</td>
</tr>
<tr>
<td>9+01.55R</td>
<td>16.81</td>
<td>Catch Basin</td>
<td>0.00</td>
<td>25</td>
<td>4745.00</td>
<td>4887.00</td>
</tr>
<tr>
<td>10+50.51L</td>
<td>25.39</td>
<td>Traffic Sign</td>
<td>0.00</td>
<td>27</td>
<td>4872.00</td>
<td>5043.00</td>
</tr>
<tr>
<td>4+03.48R</td>
<td>22.15</td>
<td>Light Pole</td>
<td>0.00</td>
<td>28</td>
<td>4657.00</td>
<td>4454.00</td>
</tr>
</tbody>
</table>

**Pick point or point numbers (Enter to End): press Enter**

**Keyboard Command:** calcoff

**Prerequisite:** A centerline (.CL) file, polyline or two points

**Distance Between Two Entities**

This command reports the average, minimum and maximum distances between two entities. For example, this command can be used to find the minimum distance between a right-of-way polyline and a property perimeter.
polyline. The supported entities include polylines, lines and arcs. The reports the coordinates along the two entities at the minimum and maximum distances.

Prompts

Select first polyline, line or arc: pick a polyline
Select second polyline, line or arc: pick a polyline
Average distance 15.335
Maximum distance 50.592 at 1929333.693,231112.910 and 1929297.650,231148.413
Minimum distance 11.870 at 1929473.749,231310.277 and 1929465.293,231318.606

Pulldown Menu Location: Centerline
Keyboard Command: minmax2
Prerequisite: Two entities

Centerline Conversions

There are twelve Import options available in Carlson Civil to convert other applications' centerline files to Carlson Civil centerline files (.CL), and seven Export options to convert Carlson Civil centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create, each Export option prompts for .CL file to convert and a file name for the new file. The import formats include C&G Point Group .PTS, Geodimeter .ARE/.GEO/.RAW, GeoPak .OSD, Leica .GSI, MOSS .INP, SDMS .ALI/.PRJ, Softdesk, Sokkia .SDR, ISPOL .ALI, CLIP .PLA, TDS .RD5 and Terramodel .RLN/.ALN. The export formats include C&G Point Group .PTS, Leica .GSI, SMI .CH, Softdesk, Sokkia .SDR, Topcon .RD3, Trimble .DC, TDS .RD5 and TDS .PL5.

For the TDS RD5, there is an option to include a profile along with the centerline. Also, there is an option to include sections. When sections are included, the station data is included in the RD5 and the section grades are output to TP5 files where each station has a separate file for the left and right sides. The TP5 files are created in the same folder as the RD5.

For the Trimble DC, there are options to include a profile and sections along with the centerline.

Pulldown Menu Location: Centerline > Centerline Conversion
Keyboard Commands: geod2cl, geopak2cl, geopak2rd, wildcl2, moss2cl, sdms2cl, dcac2l, sdr2cl, ali_to_cl, pla_to_cl, importrd5, tm2cl, wildcl1, smicl1, dcac11, cl2sdr, cl_to_rd3, export_rd5, tdscl1, export_dc

Enter Right of Way

This command adds right of way information to a centerline file which must be created before running this command. The right of way is created by entering station-offset points or picking points. A right of way polyline is drawn through the points and each point is labeled with the station and offset. Besides drawing the right of way, this data can also be used in Process Road Design to limit the cut/fill slopes.

Prompts
Choose Centerline to Process Specify a centerline file.
Layer name for labels <ROW>: press Enter
Number of decimal places for labels <2>: press Enter
Side for right of way (Left/<Right>): press Enter
Starting station of centerline: 0.000
Enter station or pick a point ('U' to Undo, Enter to End): 0
Enter offset: 35
Enter station or pick a point ('U' to Undo, Enter to End): 200
Enter offset: 35
Enter station or pick a point ('U' to Undo, Enter to End): 250
Enter offset: 50
Enter station or pick a point ('U' to Undo, Enter to End): 300
Enter offset: 50
Enter station or pick a point ('U' to Undo, Enter to End): pick a point
Enter station or pick a point ('U' to Undo, Enter to End): press Enter

The end result is a new polyline and a fully annotated ROW line plot. The Enter ROW command can be used to create new polylines that can be applied to templates using the command Template Point Centerline.

Polyline to Right of Way
This command adds right of way information to a centerline file which must be created before running this command. The right of way is created by selecting a polyline that represents the right of way. The station and offset for each point relative to the centerline is stored as the right of way data in the centerline file. There are two applications for this data. The Draw/Label Right of Way command can be used to label each point with the station and offset. Also this data can also be used in Process Road Design to limit the cut/fill slopes.

Prompts
Choose Centerline to Process Specify a centerline file.
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents right of way: pick a polyline
Side to apply right of way (<Left>/Right)? press Enter

Pulldown Menu Location: Centerline
Keyboard Command: rowpl
Prerequisite: A polyline and centerline file

Label/Draw Right of Way

This command draws and labels right of way polylines from data stored in a centerline (.CL) file. The right of way data consists of station and offset points for the left and right sides of the centerline. This data can be created with the Enter Right of Way or Polyline to Right of Way commands. Each right of way point is labeled with a leader that has the station on top and the offset on bottom. The station label is partial which only shows the number after the '+'.

Prompts

Choose Centerline to Read Specify a centerline file.
Layer name for labels <ROW>: press Enter
Draw right of way polylines (Yes/<No>)? press Enter
Number of decimal places <2>: press Enter

Right of Way polylines and labels along a centerline

Pulldown Menu Location: Centerline
Keyboard Command: drwrow
Prerequisite: A centerline file with right of way data

Horizontal Speed Table

In the design of curve and spiral-curve-spiral centerlines, it's very important to determine the curve radii and superelevation rates, which can significantly affect the design speed of roads. The Horizontal Speed Table function provides a few of speed tables, which utilize AASHTO's speed table data and offer the recommendations for design speeds and curve parameters. Please refer to AASHTO A Policy on Geometric Design of Highways and Streets 2004 (pp 167-174) for details.

The Horizontal Speed Table function is integrated into the Input-Edit Centerline File command. To access the speed tables, in the curve or spiral centerline design dialogs, click on the Horizontal Speed Table button to open the speed table dialog shown as below. The Table Name list contains the names of all speed tables that has been defined. There are five default speed tables: AASHTO 4% MAX MSE, AASHTO 6% MAX MSE, AASHTO 8% MAX MSE, AASHTO 10% MAX MSE and AASHTO 12% MAX MSE. You can add, edit and delete any speed tables. On the left of the dialog, the Design Speed box lists all design speeds. On the right there is a table that lists all the
curve and superelevation data of the highlighted speed. The curve and superelevation data table will change when
you highlight different speeds. All speed table files are in the ...\USER folder and are available for all projects.

Horizontal Speed Table

There are three buttons under the Design Speed list. Add button adds a new design speed to the current speed table.
The New Speed dialog opens for you to enter the Design Speed, and MSE and Minimum Radius for the speed. Edit
button allows you to edit the highlighted design speed. Delete button will delete the highlighted speed and all the
curve and superelevation data associate to the speed.

New Design Speed

Edit Design Speed

Under the table of the curve and superelevation data, there are Add, Edit and Delete buttons which allow you to add,
edit and delete the data entry for the highlighted design speed.
New Curve and Superelevation Data

If you have a special design speed or superelevation rate that is different than any data entry in the speed table, or if you don't want to look up the tables for a curve data, the Superelevation Calculator button is here to help you to get the curve data. Click on the button to open the Superelevation Calculator dialog. Enter the values in the Superelevation and Design Speed boxes, the Minimum Radius and Curvature will be calculated and displayed.

Superelevation Calculator

New Table button creates a new speed table, Edit Table button is used to modify the name of current table or the file that stores the speed data, Duplicate Table button makes a new speed table that contains the same data as current table, and Delete Table button removes current table completely.

Profile Menu

The Profile menu shown below has commands for creating, drawing and reporting profiles.
Quick Profile

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities, 3D polyline or surface files (grid or triangulation).

**Screen Entities:** The program creates the profile by finding the intersections of the centerline with 3D linework entities in the drawing. There's an option for whether to ignore entities at zero elevation.

**3D Polyline:** Creates a profile using a selected 3D polyline. The polyline vertex elevations are used for the profile elevations and the profile stations are from the lengths of the polyline segments.

**Surface File:** This option allows you to use one or two grid or triangulation surfaces. There's also an option to Show Pipe Crossings which will find and display pipe crossings from sewer networks and 3D polylines tagged as pipes. The sewer network can be created in the Hydrology module. To tag a 3D polyline as a pipe, use the Assign Pipe Data To Polyline command.

Since picked points are the default for the horizontal alignment, the command is as quick as select surface type (screen or file), then *Pick, Pick, Enter* and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.
**Vertical Exaggeration:** Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action:** Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only:** Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment:** Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model.

**Save:** Writes the current profile data to a .PRO file.

**Draw:** This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Print:** This makes a graphic report of the profile in either PDF or DWF format as selected under Settings->Configure.

**Exit:** Exits this command.

**Help:** Opens on-line help.

---

Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.
Prompts

Pick starting point (CL-Centerline, P-Polyline): screen pick alignment points for profile
Pick second point: pick next point
Pick next point (Enter to end): press enter to end
Tested 58 of 58 Entities Intersects found > 33

Dialog Box

Pull down Menu Location: Profiles
Keyboard Command: quickpro
Prerequisite: 3D screen entities or surface file

Profile from Surface Entities

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.

File: Displays the name of profile to be created.
Beginning Station: Specify the beginning station for the profile.
Interpolate Endpoint Elevations from Beyond Profile Extents: When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.
Extrapolate Endpoint Elevations to Extents of Profile: This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.

Station by another reference centerline: When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.

Breakpoint Descriptions from Layers: When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.

Ignore Zero Elevation Lines in Surface Model: When checked, any zero elevations selected in the surface model are ignored.

Profile Offsets: Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30' left and 30' right offset profiles). After entering the offset values, press TAB to select file options described below.

Offset Profiles to: Specify whether offsets profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30' right offset profile, it will be named NATGRD30.PRO.

Prompts

Profile File to Write dialog Specify a new profile file (.PRO) name to create.
Profile from Surface Model dialog Make choices, click OK.
Polyline should be drawn in direction of increasing stations.
C1. File/<select polyline which represents the profile centerline>: pick the centerline (Do not press Enter.)
Select Lines, PLines, and/or 3DFaces that define the surface for profiling.
Select objects: C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)

Keyboard Command: prosm
Prerequisite: A polyline centerline and surface lines and polylines.

Profile from Grid or Triangulation Surface

This command creates a profile (.PRO file) from a centerline polyline and a surface model stored in a 3D grid file (.GRD) or triangulation file (.TIN or .FLT). The polyline defines the alignment of the profile and the grid defines the surface.

After selecting the reference surface file, there is a Profile Options dialog with these options:

Link Profile To Triangulation: This option will update the profile whenever the reference triangulation is modified.
Type of Centerline: This setting chooses the type of stationing for centerline curves.
Station by Another Reference Centerline: This option uses a second reference centerline for the stationing of the profile. The main centerline is used to find the elevations on the surface and then these main centerline positions are projected onto the reference centerline to get the stationing. The reference centerline needs to extend along the full range of the picked polyline in order to project correctly and capture offsets along the entire length of the picked centerline.
Profile Offsets: In addition to creating the profile along the centerline, you can also create profiles offset left and right.
Prompts

Choose Grid or Triangulation file to process  Select existing .GRD, .TIN, or .FLT file.
Profile Options dialog.
Choose PROfile file to Write dialog Enter a profile file (.PRO) name to write.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: select a polyline
Polyline should have been drawn in direction of increasing stations.
CL File/<Select Reference centerline polyline>: select a polyline
CL File/<Select Reference centerline polyline>: press Enter
Reference CL starting station <0.0>: press enter

Pulldown Menu Location: Profiles > Create Profile From ...
Keyboard Command: progrid
Prerequisite: A .GRD grid file, .TIN, or .FLT tmesh file

Profile from 3D Polyline
To create a profile (.PRO), Profile from 3D Polyline uses X-Y distances between the points of a 3D polyline for sequential stations and the Z values at these points for profile elevations. In the options dialog, Profile Name is an optional description for the profile. The Prompt For Elevations option will prompt for the elevation at each polyline vertex to use for the profile instead of using the polyline elevations. The Station By Another Reference Centerline method locates the station for each polyline vertex along a reference centerline and uses this reference station instead of the polyline distance for the profile stationing. The reference centerline can be defined by another polyline or centerline file (.CL). When using the reference centerline, the Combine Multiple Polylines Into Profile option allows you to select multiple 3D polylines and put the data into a single profile. For example, you can use these two options to create a profile of curb elevations with road centerline stationing by selecting multiple 3D curb polylines and the road centerline as the stationing reference.
After the options dialog, the program prompts for the .PRO file to create and then the 3D polyline to process.

**Prompts**

**Profile From 3D Polyline dialog**
**Profile File to Write dialog** Specify a profile file name to create
**Select polyline to profile:** pick a 3D polyline

Created 72 data points for profile C:\sample\abc.pro
The new profile is then stored.

**Pulldown Menu Location:** Profiles
**Keyboard Command:** pro3dp
**Prerequisite:** A 3D polyline

---

**Profile from 3D Points**

This command creates a .PRO file using the X-Y distances between user-specified points for sequential stations and the Z values at these points for profile elevations. Unlike many of the Carlson profile routines, this routine does not require a pre-determined horizontal project alignment. Point numbers or screen picks (on entities with elevation) may be used to define the profile. If point numbers are used, a series of numbers may be abbreviated (1-20) or multiple non-sequential point numbers can be entered in one string provided they are separated by a comma.

**Prompts**

Pick point or point numbers (Enter to end): 34
Point number: 34 Desc: 17
(4088.82 4048.75 17.9747)
Pick point or point numbers (Enter to end): 94
Point number: 94 Desc: 18
Station: 1150.0727
(4898.41 4865.6 5.11402)
Pick point or point numbers (Enter to end): 195
Point number: 195 Desc: GROUND/SHOT
Station: 2253.0427
(4160.4 4045.91 20.4635)
Pick point or point numbers (Enter to end): 

A dialog appears which offers the option to store the data in a profile, in a section file or cancel.

**Type of File to Write dialog** Choose Profile
If you choose Section, you will make a section file with Station 900001, which can be plotted as a cross section. The section is left-justified, with the first point representing offset 0 and all other offsets to the right. The section offsets will match the profile stationing if the same points are used.

Opened file: c:\scad2005\data\drawing431.pro
Profile Data stored in: c:\scad2006\DATA\Drawing431.PRO

In this graphic showing the points 34, 94 and 195, note that the "+" in front of elevations higher than 0 is an option within Draw-Locate Points.

Pulldown Menu Location: Profiles > Profiles from ...
Keyboard Command: pro3dpt
Prerequisite: Plot points or contour lines with real Z axis elevations.

Profile from Section File

This command creates a .PRO file from user-specified offsets or from specified descriptions on cross sections contained in a .SCT file. The elevations of the profile are derived from the elevations of the cross sections at the offset and the stationing for the profile matches the stations of the cross sections. There is an option to extend cross section elevations to reach the offset for the profile when necessary. If, for example, a road design has "SH" at some offset on each cross section, both left side and right side, you can pull the profile from the "SH" descriptions by specifying left or right side. So you can profile the shoulder, or the "TIE" point to existing ground, etc. Alternately, if the sections extend from offset 100 left to offset 100 right, you can pull a profile at offset -30, or 30, in which case the program will create a profile by interpolating the elevation from the sections for each station in the cross section file.

Prompts

Choose SCT file to read dialog
Select the existing cross section file.
Profile of offset or template description [<Offset>/Desc]? press Enter
Enter the offset to profile (left offsets as negative) <0.0>: press Enter
Extrapolate sections to this offset (<Yes>/No)? press Enter This prompt appears if the program detects that some or all sections do not extend to the requested offset to profile.
If you chose Desc above, one of the advantages of the new file loading dialog is that you can review the ASCII descriptions in the section file, as shown below:
Enter description to profile: EP
Template side to process [Left/<Right>]? L
PROfile file to Write dialog boxEnter a profile file name to write.
Create another profile (Yes/<No>)? press Enter
Profile from Points on Centerline

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).

Prompts

**Profile to Write dialog box:** Enter a new profile file name to write.

**Select Polyline that represents centerline**: pick a polyline or choose C for Centerline

Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.

Note: for all selected points, the points should be located on the real Z axis.

Select the Carlson points along the centerline.

Select objects: Select the point entities.

Keyboard Command: profpts

Prerequisite: A polyline centerline and points

Profile from Polyline on Profile Grid

This command allows you to convert a polyline that is drawn on a profile grid into a profile (.PRO) file. The polyline must be drawn in the direction of stationing. Vertical curves, which are typically parabolas, will be captured as a series of vertices. The polyline can either be used to create a new profile (.PRO) file, or can be appended to an
Prompts

File Selection Dialog Box Specify the profile (.PRO) file to create, or an existing profile (.PRO) file to append to.
Profile Settings Dialog Set these parameters to match the dimensions of the grid for the profile plot.
Pick Lower Left Grid Corner: pick the grid corner Endpoint snap is set on.
Profile number <1>: press Enter This is an optional profile name used for multiple profiles.
Select the polyline to write profile from:
Select object: pick the 2D polyline in the grid
A station and elevation report is produced.

Pulldown Menu Location: Profiles > Create Profile From...
Keyboard Command: pro2dpl
Prerequisite: Drawn polyline which represents profile, existing drawn profile grid

Profile from Layers

This command creates a profile from surface entities with one of the specified layers. The surface entities can be contours, triangular mesh, and other 3D drawing entities. This command is the same as Profile from Surface Entities with the addition of the layer filtering. The method is to draw a polyline as the profile centerline. Then run Profile by Layers and specify the layer names of the surface entities to include in the profile. For example, the layer names CTR and TMESH could be entered to use only the contour polylines and triangulation mesh on these layers. Entities on all other layers would be ignored. The profile is derived from the intersections of this polyline with the 3D entities on the specified layers.
Prompts

Declare Layers Selection Dialog Specify layers, click OK
Profile File to Write Dialog Specify a profile file name (.PRO) to create
Profile from Surface Model dialog box
Polyline should be drawn in direction of increasing stations.
CL File/<select polyline which represents the profile centerline>: Pick the centerline
Select surface entities on corresponding layers.
Select objects: C For crossing and window everything the centerline crosses.

Pulldown Menu Location: Profiles > Profile from ...
Keyboard Command: prolayer
Prerequisite: A polyline centerline and surface lines and polylines.

Profile from Pipe Polylines

This command creates a profile that contains the station, elevation and pipe width of pipes that cross the centerline. This type of profile is called a Crossing profile and Draw Profile treats it differently. Instead of connecting the station-elevation points with a polyline, Draw Profile draws each station-elevation as a circle with a radius of the pipe width. When there is a vertical exaggeration in the drawn profile, the pipe circles are drawn as ellipses.

This routine uses a polyline that represents the centerline. The pipe polylines are 3D polylines with an assigned pipe width. One way to create them is to use the command Draw Pipe 3D Polyline in the Profile Utilities sub-menu. To attach the pipe width value to a polyline, use the Assign Pipe Width to Pline command also in the Profile Utilities sub-menu. The program then finds the intersections of the polyline centerline with the pipe polylines and stores the station of the intersection along the centerline with the elevation and pipe width of the pipe polyline. There is also a prompt to whether the pipe position is at the top, bottom or middle of the 3D pipe polylines.

Prompts

Profile File to Write Dialog Enter new .PRO file name.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick a polyline
Enter the starting station <0.0>: press Enter
Select the pipe polylines crossing the centerline.
Select objects: pick pipe polylines
Position of pipe polylines on pipe [Top/Center/<Bottom>]? press Enter

Found 2 crossing pipe polylines.
The command Draw Profile would then interpret this profile as a pipe profile, and plot it as needed.

**Pulldown Menu Location:** Profiles > Profile from ...

**Keyboard Command:** propipe

**Prerequisite:** A polyline centerline and pipe polylines

---

**Enter Profile On-Screen**

This command allows you to create profile files and is similar to *Design Road Profile*. The only difference is that Enter Existing Profile does not ask for vertical curves. The procedure is to first specify the on-screen grid and then enter or pick the stations and elevations. The profile is drawn as it is entered.

Notice that the station, elevation, and slope at the current position of your cursor crosshairs is displayed at the bottom of the side-bar menu. These values will update whenever the crosshairs move except after selecting either the side-bar or top menu.

---

**Prompts**

**Profile Settings dialog**

**Profile File to Write dialog** Specify a profile file (.PRO) to create.

Station of first PVI or pick a point: 0

Elevation of PVI: 565

Second station or pick a point (U, E, D, Help): 200 'U' is undo, 'E' ends the routine, 'D' is incremental distance to the next station, 'H' brings up an explanation of these items on-screen.

**Percent grade entry/Ratio/<Elevation of PVI>:** 575

Station of next PVI or pick a point ('U' to Undo, Enter to End): pick a point

**Snap PVI dialog**

This dialog box appears when you pick a point and the Prompt for Snap option in the Profile Settings dialog is selected. The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value.

Station of next PVI or pick a point ('U' to Undo, Enter to End): press Enter
Pulldown Menu Location: Profiles
Keyboard Command: makeprof
Prerequisite: A profile grid drawn on-screen

Input-Edit Road Profile

This command opens the Input-Edit Road Profile dialog, showing the profile graph and a spreadsheet table containing the profile data. With this dialog, you can enter and edit road profile files (.PRO), not only by specifying the values in the spreadsheet, but also by editing the PVI points on the profile graph directly. The updates in the spreadsheet and the graphic box are synchronized.

From the Profile menu in the Civil Design Module, choose Input-Edit Road Profile. The program reads a road profile file (.PRO), a road centerline file (.CL) and a surface file (.TIN or .FLT). If you design a new road profile, just enter the new road profile file name. If you open an existing profile to edit, the profile graph is shown in the graphic box on the top, and the spreadsheet is filled with profile data. The buttons and lists between the graphic box and the spreadsheet provides the abilities to input and edit the road profile in graphic.
1. Functions Editing Profile in Graphic:

- **Switch to pan mode button**: Switch the cursor to PAN mode.
- **Switch to dynamic zoom mode button**: Switch the cursor to ZOOM mode.
- **Zoom Extents button**: Zoom the graphic window to show the complete graph.
- **Add PVI button**: Allow you to add a new PVI point by picking at any locations inside the graphic box. The program will extract the station and elevation of the point and display them in the New PVI dialog, from where you can modify the station and elevation directly in the Station and Elevation boxes, or by modifying the Slope In and Slope Out values. You can also specify the vertical curve length or sight distance to define the vertical curve of current PVI. The resolution snap for the station and slope round up the station and slope values. Click on OK button to save the new PVI data. Below is an example of the dialog.

![New PVI dialog](image)

- **Edit PVI button**: Pick an existing PVI point on the profile graph and drag it around to change the station and elevation.
**PVI Edit Mode list:** This list has five options: Free, Hold Slope In, Hold Slope Out, Hold Station and Hold Elevation, which controls the movement of the PVI that is being edited by the Edit PVI button command.

**Vertical list:** This list determines the vertical exaggeration of the profile graph.

---

**2. Spreadsheet Editor:**

The spreadsheet editor allows you to enter and modify data cell by cell. The profile graph will be updated automatically after any changes of the profile data. **Insert PVI** button inserts a row in front of the highlighted row to create a new PVI, **Remove PVI** button deletes the highlighted row as while as the corresponding PVI, and **Screen Pick PVI** button allows you to pick a point on screen and insert it into the spreadsheet. In the **Sag-Crest Points** list, the coordinates of all Sag and Crest Points are listed.

---

**3. Settings Dialog**

Click on the Settings button, the settings dialog displays.

**Hold Current Elevation:** When you change a PVI's station or elevation, if this toggle is on, its slope out will be changed and the elevation of the next PVI is held, otherwise its slope out is held and the elevation of the next PVI will be changed.

**User K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column of the spreadsheet.

**Grid Ticks Only:** Toggles between displaying the grid and grid ticks in the graphic box.

**Show Slope When Zoom In:** This option allows to display the slopes on the long enough profile segments when zoom in.

**Show Reference Surface:** An option to show the reference surface profile along with the road profile in the graphic box.

**Show Reference Surface At Left Offset:** An option to show the reference surface profile at an user-specified left offset of the road centerline.

**Show Reference Surface At Right Offset:** An option to show the reference surface profile at an user-specified right offset of the road centerline.

**Show Centerline Special Stations:** When this toggle is on, the points at centerline special stations such as PC, SC, ST, TS and SP are shown in the graphic box.

**Show Vertical Lines for Intersections:** When this toggle is on, vertical lines represent intersections of two road profiles are shown.

**Show Sag-Crest Points:** An option to draw the sag and crest points in the graphic box.

**Output Reference Surface Profile:** An option to output the surface profile to a file whose name has a suffix of the current road profile file name.

**Set button:** Set the current Reference Surface file to another one.

**Drag PVI Options:** When pick an existing PVI point on the profile graph and drag it around, you may choose to hold either the vertical curve length, or the K-value, or the sight distance.
4. Show Sections

This function applies the design template at the road profile to get the road section file, computes the outslopes and earthworks relative to the reference surface section file, and displays both road and surface sections in a graphic dialog box. Click on the Show Sections button, the Road Design Templates dialog displays. The last 4 input items are strictly optional design files.

**Design Template:** Specify a template file (.TPL) or template series file (.TSF) that defines the final grade offsets and elevations and the cut/fill slopes.

**Template Transition:** Specify a .TPT file, which allows modified template files to be applied at different ranges of stations on a project.

**Template Point Profile:** This option lets you have separate profiles for template points that are independent of the centerline file.

**Template Point Centerline:** This option lets you have separate centerlines for template points that are independent of the main centerline.

**Super Elevation:** This option is used to specify a super elevation file (.SUP) that defines the super elevation transition stations on a project.

After specifying the design template file(s), click on OK button to display the section graph. In the section dialog, the graph is automatically updated when you move your cursor along the road profile graph to change stations.
5. Vertical Speed Tables

The Vertical Speed Table function provides a few of speed tables, which utilize AASHTO’s speed table data and offer the recommendations for design speeds and curve parameters. Please refer to AASHTO A Policy on Geometric Design of Highways and Streets 2004 (pp 265-280) for details.

Click on the Vertical Speed Tables button to open the speed table dialog shown as below. The Table Name list contains the names of all speed tables that have been defined. There are five default speed tables: AASHTO - Crest Curve Based On Passing Sight, AASHTO - Crest Curve Based On Stopping Sight, AASHTO - Sag Curve Based On Stopping Sight, METRIC- AASHTO - Crest Curve Based On Passing Sight, METRIC- AASHTO - Crest Curve Based On Stopping Sight and METRIC- AASHTO - Sag Curve Based On Stopping Sight. You can add, edit and delete any speed tables. All speed table files are in the ...\USER folder and are available for all projects.
Click on the Add button, the New Vertical Speed Data dialog displays. Enter values in the Design Speed, Sight Distance and K boxes. Click on OK button to commit the new speed entry. Edit button allows you to modify design speed, sight distance and K values of the highlighted speed entry, and Delete button deletes the highlighted entry from current table. New Table button creates a new speed table, Edit Table button is used to modify the name of current table, Duplicate Table button makes a new speed table that contains the same data as current table, and Delete Table button removes current table completely.

![New Speed Entry](image1)

![New Vertical Speed Table](image2)

**Prompts**

**Input-Edit Road Profile dialog:** Fill in values.

**Pulldown Menu Location:** Profiles > Input-Edit Road Profile

**Keyboard Command:** roadpro

**Prerequisite:** a road profile file (.PRO), a road centerline file (.CL), a surface file (.TIN, .FLT)

**Design Road Profile**

This command is for simultaneously creating a .pro file and drawing the road profile. It is typically used when designing a road profile on top of a plotted existing grade profile, where the goal is to minimize cut and fill and keep to a minimum the number for vertical curves and avoid excessively steep grades. It is often necessary to match the starting and ending elevations of existing roads or features. For example, a side road will contact the main road at a fixed, given elevation. One concept to remember is that it may be best to favor a little more fill than cut in the design profile, because if your design template for the road involves ditches, a little bit of cut can lead to significant extra cut volumes due to the ditch placements. The **Design Road Profile** command works fine when overlaying on profile plots with either matching horizontal and vertical scales or exaggerated vertical scales (e.g. 50 H and 5 V). Just be sure to specify the correct scale settings in the Profile Settings dialog. The procedure is to first specify the on-screen grid and then enter or pick the stations and elevations.

Once two segments have been entered, you will be prompted for the vertical curve length. The vertical curve is a parabola, the typical form used in the United States. If you don't want a vertical curve, enter 0. Otherwise you can directly enter the vertical curve, or enter the sight distance or the K-value from which the vertical curve is calculated. The vertical curve can also be specified to pass through a point or do a best fit through multiple points. This through
point option would be useful for hitting an existing feature such as a driveway on the vertical curve. Unequal vertical curves is another option where the vertical curve length going into the PVI differs from the length leaving the PVI. Before using your entry, the vertical curve, sight distance, and K-value are displayed. Object height and eye height are two variables that effect the vertical curve. Their values can be set using the command *Profile Defaults*.

Notice that the station, elevation and slope at the current position of your cursor crosshairs are displayed in real-time in a small dialog.

![Profile Settings dialog](image)

**Prompts**

**Profile Settings dialog**

**Profile to Write Dialog** Note that you can choose to append to an existing road profile, which allows you to continue design work in different work sessions. If Append is selected, the cursor will default to the end point of the selected profile, which will be treated as a 'PVI' point, so that you will be prompted for a vertical curve length after your very next picked point.

**Pick Lower Left Grid Corner** `<5000.08,3211.24>-[endp on]`: Pick a lower left corner for the plotted grid on the screen. If you have just finished plotting the existing profile, the program will remember your lower left coordinates, and you just hit Enter to accept the default values.

**Enter station or pick a point (Enter to End):** 0

**Elevation of PVI:** 932.5

**Station of second PVI or pick a point (U,E,D,Help):** 175

**Percent grade entry/Ratio/ `<Elevation of PVI>`:** 942

**Station of next PVI or pick a point ('U' to Undo, Enter to End):** *pick a point*

**Snap PVI dialog**
The Snap PVI dialog box appears when you pick a point (if the Prompt for Snap option in the Profile Settings dialog is selected). The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value. In this example, you might choose a slope snap of 0.1 and if the station was flexible (not fixed, such as the end of the road), you could choose a station snap of 10.

View Table/Unequal/Through pt/Sight Distance/K-value/<Length of Vertical Curve>: 100
For Crest with Sight Distance > VC and Vertical Curve => 100.00
Sight Distance => 124.43, K-value => 11.2
Use these values (<Y>/N)? press Enter
Station of next PVI or pick a point ('U' to Undo, Enter to End): press Enter
Vertical Curve Text Options dialog box
Pick vertical position for VC text: Pick a position above the profile grid. The final plot is shown below:
Pulldown Menu Location: Profiles
Keyboard Command: road
Prerequisite: A profile grid

Design Sewer/Pipe Profile

This command creates a sewer profile (.PRO) file with manholes, or will create a pipe profile (no manholes, no manhole width), and draws it on the screen. It requires that a grid is already drawn. It begins with the Design Sewer Settings dialog box.

Bottom Manhole Width: Specify the size for the bottom of manholes. Not available when Profile Type is set to pipe.
Max Pipe Length: Specify the maximum limit for the distance between manholes.
Min Percent Slope: Specify the minimum slope (absolute value) between manholes.
Layer name for text: Specify the layer name for annotation. If you enter a layer that does not exist, it will be created.
Profile Layer: Specify the layer name for pipes and manholes. If you enter a layer that does not exist, it will be created.
Drop Across Manhole: Specify the amount the elevation drop across the manhole in the direction of the profile. Will accept a negative a value. Not available when Profile Type is set to pipe.
Snap Prompt: Activates the PVI Snap dialog box. See below for description.
Pick Plan View Polyline: Allows you to select a polyline from plan view that represents the sewer centerline. This leads to the plotting of manhole symbols on the plan view and also creates default manhole-to-manhole stations.
Manhole Bottom At Pipe Slopes: When checked, the manhole bottom will be drawn level with the pipe slope.
Profile Type: Choose between Sewer profile or Pipe profile. Pipe profile do not include manholes.
Grid Dimensions: Specify the grid dimensions on which the sewer will be designed.
Design Method: Choose whether distances specified are center or manhole to center of manhole or actual pipe length. Not available when Profile Type is set to pipe.
New/Append: Choose between creating a new profile (.PRO) file or appending an existing file.
Depth to Use: Choose between specifying pipe top or pipe bottom elevations. Not available when Profile Type is set to sewer.

Prompts

File Selection dialog
Choose a new profile file name to create.
Pick Lower Left Grid Corner <5000.0,5000.0>[endp on]: pick the corner
Select existing ground polyline or ENTER for none: You may optionally pick a polyline to use for calculating the depth from the surface as the sewer stations are entered.
Enter station or pick a point (Enter to End): 0
Depth from Surface/<Elevation of manhole>: 935.7
Enter the step up/down in feet <0.00>: press Enter
Station of second MH or pick point (U,E,D,Help): pick a point

If the Pick Plan View Polyline option has been chosen, the program will default to the station of the next vertex in the selected polyline. If the Prompt for Snap option was selected in the main dialog, then the Snap Profile Point dialog appears here. The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value.
Enter the step up/down in feet <0.00>: press Enter Enter 0.1 if pipe drops one tenth into manhole and you are designing in upstream direction.

If you enter a station for the next manhole rather than picking a point on the screen, then you will be prompted as follows:

**Depth/Percent grade/Min grade/<Elevation of manhole>: 939.79**

**Size of pipe in inches <10.0>: 8.0**

**Station of next manhole or pick a point (U,E,D,Help): press Enter**

If you picked a plan view polyline, you will be asked:

**Draw manholes on centerline [Yes/<No>]? Y**

Then you will be prompted for the default manhole symbol to use.

**Profile Sewer Settings dialog**

**Sewer Label Options dialog** (Displayed by pressing the Annotation Options button.)

**Select existing ground polyline: pick a polyline or press Enter to be prompted for each manhole surface elevation**

This prompt only appears if no ground polyline was selected above.

**Manhole No. 1 label [MH #1]: press Enter**

**Manhole No. 2 label [MH #2]: press Enter**
Pipe/Center Combo Labeling Method calculates the slope as the elevation difference from the edge of the pipe, divided by the distance between the manhole centers.

Example of sewer profile and surface profile

Example of sewer profile using Horizontal Axis Text Orientation as Vertical and Pipe Label Position as Horizontal Dimension
Detail of manhole bottom at pipe slope

Detail of drop across manhole of 0.2

Detail of step up

Top=2, Bottom=4, Offset=100

Top=4, Bottom=4

Top=2, Bottom=4, Offset=4, Fixed=0
Detail of Draw Manhole Base and Label Invert Elevation with Vertical Line

Detail of Label Rim Elevation at Manhole

Manhole with the Draw Sump option

Label Pipe Flow Values option shows flow rate, travel time, depth and velocity

**Pulldown Menu Location:** Profiles  
**Keyboard Command:** sewer
Prerequisite: A profile grid

Input-Edit Profile File

Similar to the Input-Edit Road Profile command, this command features a spreadsheet type editor and handles a variety of profile (.PRO) configurations. Besides editing a profile, this routine can be used to just view the contents of a profile.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. The station, elevation and slopes are also shown at the lower left of the dialog which update/track with the movement of the cursor. There are between five and nine possible data fields in a profile depending on the type of profile that has been selected.

Profile Name: This name is optional and often used when multiple profiles are stored in a profile (.PRO) file and graphically generated using the Draw Profile command.

Add Row: Adds a new row into the profile after the current row.

Remove Row: Removes the current row.

Type of Profile: There are 6 types of .pro files and the spreadsheet columns will change to match the data fields for the selected profile type:

- **Generic**: Generic profiles have station, elevation and description fields.
- **Road**: Road profiles include the Generic controls and adds a vertical curve field. For an asymmetrical vertical curve, enter the left and right side values separated by a dash in the spreadsheet cell. For example, a 200' vertical curve with 50' to the left of PVI and 150' to the right would be entered as "50-150".

- **Sewer**: Sewer profiles include the Generic controls and adds step up, pipe size, pipe thickness, manhole elevation and manhole ID fields.
- **Pipe**: Pipe profiles include the Generic controls and adds a pipe size field.
• *Crossing* - Crossing profiles are for pipe crossings along the centerline. Besides station and elevation, the crossing data points also have the pipe size. The crossing elevation is for the bottom elevation of the pipe. The crossing profile data points are not connected.

• *Circular* - Circular profiles are the same as Road profiles except the vertical curve is circular instead of parabolic.

**Edit Slope To Change:** This setting controls which field to update when the slope is modified in the spreadsheet.

**Reference Profile Select:** Selects a reference profile and displays it in the profile graphic view immediately.

**Sag-Crest Points:** When editing a road profile, its sag/crest points are shown here.

**Through Pt:** This button lets user to make the road profile pass through a certain point.

**Vertical Exaggeration:** Changes the look of the profile.

**Check Stations:** Reports profile information at the specified stations. The Check Stations are not stored in the profile; they are merely used as a design/analysis tool for viewing the elevations at certain stations while adjusting the profile data.

**Speed Tables:** This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

**Next:** Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

**Previous:** Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

**Load:** Used for loading another, existing .PRO file for editing.

**Save:** Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

**SaveAs:** Allows you to save the profile under a different profile file name.

**Calc PI:** This function calculates a station/elevation point given two existing station/elevation points and slopes from them. The values are entered in this dialog. When you pick Calculate, the program finds the intersection of the grade lines. Then pick OK and the calculated PVI is added to the profile.

**Report:** Creates a report of current profile.

**Undo:** Reverts the last action in the editor.

**Settings:** Opens the settings dialog.
Hold Next Slopes: When editing a profile elevation, this option will maintain all the slopes after the edit point by adjusting the elevations. Otherwise, the elevations for the rest of the profile points are held and the slope from the edit profile point to the next profile point is adjusted.

Hold Current Elevation: When you change a PVI's station or elevation, if this toggle is on, its slope out will be changed and the elevation of the next PVI is held, otherwise its slope out is held and the elevation of the next PVI will be changed.

Use K-Value: Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.

Show Slope When Zoom In: This option allows to display the slopes on the long enough profile segments when zoom in.

Grid Ticks Only: Toggles between displaying the grid and grid ticks in the graphic box.

Set Grid Interval: This option allows you to control the elevation grid spacing in the graphic preview. When this option is off, the program automatically figures the elevation grid interval.

Enable Additional Invert-In Fields for Sewer Profiles: When editing a sewer profile, this option allows you to display an extra invert-in column for in-coming pipes. The invert-in elevations are separated by commas.

Enable Cradle Fields for Sewer Profiles: When editing a sewer profile, this option allows to display cradle above and cradle below columns.

Grid Mode: The Dynamic option will update the grid interval labels when you zoom in or out of the profile image. The Static option will keep the grid interval labels static.

Tools: Opens the Tools dialog.

Translate: Globally adds or subtracts value to stations and/or elevations within the specified range of stations. while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.
Scale: Applies the specified scale factor to stations and/or elevations within the specified range of stations.

Reduce: Reduces the profile points by the Offset Cutoff value.

Reverse: Reverses the direction of the stationing for the profile.

Cradle Setup: Sets up the cradles for sewer profiles. The cradle parameters are different with different pipe sizes and are defined in the Pipe Size Library. You can either use library data or specify new values here.

Pulldown Menu Location: Profiles

Keyboard Command: profedit

Prerequisite: None

Draw Profile

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or
without a grid or with just tick marks. The vertical curve annotations for a road profile and manhole annotations for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. Please note, several of the options presented in the following dialogs will depend on the type of unit system being used, metric or english. Options such as text sizes, sheet dimensions, and scaling factors may vary from the examples shown here.

The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw. The graphic window shows the highlighted profile in the list. The Set button allows you to indicate a "primary" centerline that is used as the basis for stationing when creating Plan & Profile sheets. Add and Remove buttons allow you to select more profile files to the list and remove the highlighted profile from the list. The Clear button removes all the profiles. When a highlighted profile file has multiple profiles, the Multiple Profile button is enabled, which opens a dialog for choose which profile to draw. The Open Set and Save Set buttons are used to load or store the profile selection to a .PST file. Click OK button to go to the next step. The Draw Profile dialog box appears, and contains all of the settings for creating the profile.
**Draw Grid**

This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.

**Horizontal Grid:** Enter a value of how often grid lines should be displayed to coincide with the station values along the horizontal axis of the grid.

**Horizontal Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide
with the station values along the horizontal axis of the grid.

**Station Text:** Indicate how often station text labels should appear along the horizontal axis of the grid.

**Vertical Grid:** Enter a value of how often grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Vertical Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Elevation Text:** Indicate how often elevation text labels should appear along the vertical axis of the grid.

**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs East to West and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate.

**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Grid Style:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Draw Vertical Bar on Right:** This option places the vertical label bar on the right of the grid, as opposed to the left.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile. Click the **Setup** button to establish the desired Scale labels and placement values.

![Label Scale Setup](image)

**Label Stations:** Disable this option if you do not want station labels to be placed along the grid.

**Label Station Equations:** Disable this option if you do not want station equation labels to be placed along the grid.

**Station Type:** Indicated the preferred style of station formatting.

**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:

![Station Text Orientation](image)

**Use Partial Labels for Intermediate Stations:** Enable this toggle if the "full station" content to the left of the "+" symbol should be omitted at intermediate stations. This is useful for large station values where intermediate station
labels are desired. When enabled (assuming 100' station values), an intermediate station such as 1023+50 would simply be annotated as +50.

**Increment Station Text from Beginning Station:** Enable this option if you wish to have the station text labels be relative to the starting station value. For example, if the starting station value is 0+23.68 and the *Station Text* interval is 50, station labels of 0+73.68, 1+23.68, 1+73.68, *etc.*, would be generated.

**Label Elevations:** Disable this option if you do not want elevation labels to be placed along the grid.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile, unless the Draw Vertical Bar on Right option is selected.

**Draw Elevation Labels Only On Left Side:** Enabling this option eliminates elevation labels on the right side of the profile.

**Draw Grid Line Under Elevation Labels:** Enabling this option extends the grid lines underneath the elevation labels.

**Elev Text Vertical Justify:** Indicate vertical justification for the elevation labels.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Stack Profile Grids:** This option allows to stack profile grids for multiple profiles. In the Setup dialog, all profiles in the multiple profile file are listed and you can choose which one goes to first grid, which one is second and so on.

**Grid Vertical Spacer:** Indicate the amount of vertical space between successive grids.

**Draw Sheet**

Plan Only, Profile Only, or Plan and Profile sheets can be created. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog.
Choose Space: Indicate whether sheets are to be drawn to Paper Space (also known as a Layout) or to Model Space.

Layout Name: Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1.

Note:

- The "Tile Sheets" toggle needs to be disabled for the auto-incrementing functionality.
- If either the Start Station in Layout Name or the End Station in Layout Name options are enabled, the Layout Name field will be disabled as the Layouts will get named automatically.

If you enter "ms" to go to model space within a Layout tab, you can pan to alter the plan view position. However, it is best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

```
Model \ Layout1 \ LAYOUT2
```

Start/End Station in Layout Name: These options allow you to include starting and ending station in the Layout Names.

Add Layouts to Current Layout Set: This option allows you to add the layouts created to an existing layout set that was previously generated using the Layout Set Manager. You will need to specify the name of the layout set.

Add Layout Name To File Name For Output To Drawing: When the option to Output To Separate Drawing is on, this option will create a separate DWG file for each layout by adding the layout name to the main DWG file name.

Block Name: This is the drawing name for the plan and profile sheet to be inserted. The Set button can be used to change the block name. Carlson provides a standard plan and profile border in the form of profile.dwg located in the working folder of %AppData%\Carlson Software\...\Sup\profile.dwg. You may wish to revise profile.dwg and add your company logo, and re-save it as profile1.dwg. Alternatively, you could add your own complete version of a Plan and Profile sheet block/border. Be aware that the Draw Right to Left option in Draw Grid is superseded when Draw Sheet is enabled. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command.
**Set Sheet Attributes:** This button allows you to specify the values used by any attributes associated with the sheet block. These can be entered manually in the Set Sheet Attributes dialog.

![Set Sheet Attributes dialog](image)

You can use the Set button to the right of any field to set that field to a preset value pulled from the drawing information.

![Set Sheet Attribute dialog](image)

**Sheet Width:** This is the profile width, in inches, on the sheet.

**Lower Left Offset X/Y:** Indicate the offset value(s) for the insertion point of the sheet in CAD units. This option allows user-defined Block Names to be properly positioned relative to the remainder of entities placed through the Draw Profile command.

**Draw Profile Grid Lines:** Enable this option if your Block Name does not contain profile grid lines and if you want profile grid lines to appear on the sheet.

**Draw Plan/Grid to Full Sheet Width:** Enable this option if you want to have "partial" sheets (typically found at the end of a Plan & Profile Sheet run) occupy the full width of the sheet.

**Sheet Contains:** This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.

**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Plan/Profile Gap:** Indicate the amount of vertical separation between the Plan portion of the sheet and the Profile portion of the sheet.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view. Click the **North Arrow Settings** button to establish the desired North arrow and placement information.
**Draw Plan View Borders in Model Space:** This draws the borders in Model Space which can be useful or orienting text and other labels to the orientation of the sheet. When this option is selected, use the Layer text box or Set button to choose the layer on which the borders will be drawn.

**Plot at 1:1:** With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1”=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the **Sheet Lower X** and **Sheet Lower Y** values. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

**Fit Each Vertical:** With this option turned on, the program will size the profile grid to fit within the vertical space on the profile sheet. With this option off, the profile grid is sized to fit the elevation range of the profile.

**Tile Sheets:** If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.

**Overlap STA** In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.

**Draw Horiz Axis Elev**

This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog. A preview of the labels will be shown to the right of the settings. If the preview does not match the settings, click the Update Preview button.
Linear and Curve Interval: Indicate how often the profile elevation labels should be placed along the horizontal axis of the sheet. The Curve Interval applies within vertical curves and the linear applies everywhere else.

Draw Tick and Tick Height: This option draws a line at the specified height at each station for the elevation labels.

Existing/Final Grade: Indicate the appropriate profile, precision, text scale, layer, style, prefix, suffix and color for the text labels.

Text Layout: Indicate whether the text labels should be oriented vertically or horizontally.

Label Offset Scale: Indicate the distance from the horizontal axis for the labels. If the value is negative, the labels are placed above the horizontal axis.

Elevation Difference Options: If both existing grade and final grade are to be drawn, you may choose to also label the Cut/Fill depth value that separates the existing and final profiles at each station.

Draw Horiz Label Box

This option draws a boxed area either above or below the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog which has a list of available fields to label. To label a field, highlight the field from the Available list and pick the Add button. Then use the Up/Down buttons to order the fields in the Used list.

Offset: This controls how far to offset the label box from the profile. This value is a scaler that is multiplied by the profile horizontal scale.

Draw Vertical Lines: This option draws lines from the data point on the profile to the label in the box.

Draw Box Lines: This option draws the row and column lines for the label box.
Use the Edit button to set parameters for the label in the box. The Label 2nd Row option creates another row for the field.

An example of the resulting plot is shown here:

<table>
<thead>
<tr>
<th>Station</th>
<th>0+00.00</th>
<th>0+13.45</th>
<th>0+24.43</th>
<th>0+50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>140.09</td>
<td>139.95</td>
<td>140.66</td>
<td></td>
</tr>
</tbody>
</table>

**Draw Slope Labels**

When enabled, this option allows you to detail additional slope information onto selected profiles.
Indicate the desired profile(s) whose slope annotation you'd like to control and click on the Setup button for expanded criteria.

**Draw Break Point Sta**

When enabled, this option will label station values along the profile line above each break point in the profile. Pick **Setup** to access the Break Point Station Setup dialog.
Draw Break Point Elev

When enabled, this option will label elevation values along the profile line at each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.

![Break Point Elevation Setup dialog]

Draw Break Point Desc

When enabled, this option will label descriptions along the profile line at each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.

![Break Point Description Setup dialog]

Draw Break Point Elev Diff

When enabled, this option will label elevation difference values along the profile line at each break point in the profile relative to a reference profile (e.g. existing grade). Pick Setup to access the Break Point Elevation Difference Setup dialog.
**Reference Profile:** Indicate the profile that should be used as the point of comparison for the break point locations.

**Decimal Shift Right:** Indicate the number of places to shift the decimal point to the right. For example, if a traditional elevation difference was calculated to be 1.234 and the Decimal Right Shift value is set to 1 (a factor of 10), the reported elevation difference would be shown as 12.34.

**Break Point Leader/Symbol Setup**

Click this button to establish if it desirable to have a leader and/or break point symbol used in conjunction with the **Draw Break Point Sta** and/or **Draw Break Point Elev** options.

**Draw Road Intersections**

When enabled, this option will label the location(s) of any road(s) from an identified Road Network that intersect the main road.
Draw Linework Crossings

This option draws labels for linework that crosses the reference centerline. The reference centerline is set in the first Draw Profile dialog where the profiles to draw are selected. The setup dialog for Linework Crossings has a list of layers. The program will find intersections between the reference centerline and linework on these specified layers. For each layer, there is a Description which is used for the label on the profile. Besides labeling these descriptions for the crossings, the program includes the station along the reference centerline at the crossing. In the options dialog, there are settings to control the layer, style, color, size, decimal places for the station label, label position and whether to draw a vertical line from the label to the profile.
Output to Separate Drawing

When enabled, this option draws the profile(s) to a separate drawing. Click the Set button to specify the name/location of the external drawing. Suggested uses for this feature are when profile-only sheets need to be generated and provided to others for detail or construction purposes.

Link To Files: This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s):

- **Off** - Changes to an underlying profile file do not trigger a change to its drawn profile.
- **Prompt** - Changes to an underlying profile file trigger a prompt if its drawn profile should be updated.
- **Auto** - Changes to an underlying profile file result in an automatic change to its drawn profile.

Match Line Elevations: For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion vertically shifted to remain in the profile portion of the sheet.

Elevation Range: This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range greater than 40), the program will break the profile and draw the remainder with a separate vertical axis range.

Road Labels

This button opens Vertical/Circular Curve Settings dialog. From a wide variety of available labels, you are able to create your own label selections very conveniently. Each label can be edited individually through the Setup button. You can specify the prefix, suffix, symbol style, decimal places, text orientation and position, *etc.*, in the Edit Label dialog.
**Draw PVI 'V':** You can choose to draw either a full tangents style PVI 'V' point, or a partial tangents style, or nothing.

**Label Placement:** This setting determines where to place the vertical curve labels. There are six options: Pick Single Row, Pick Individual Position, Auto Place Above Highest PVI Point, Specify Offset from Grid Top, Offset from Curve - Aligned, Offset from Curve - Horizontal.

**Label Offset from Grid/Curve:** Indicate the distance from the Grid or Curve when the Label Placement option is set to Offset from Grid Top or Offset from Curve, respectively.

**Draw Horizontal Dimension Lines:** This option draws horizontal lines connecting the PVC and PVT of all vertical curves.

**Draw Vertical PVC & PVT Lines:** This option draws vertical lines emanating from the PVC and PVT of all vertical curves.

**Label PVI When VC=0:** When vertical curve length is 0, no label is created unless you choose this option and then the PVI label would be shown.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Arrow Direction:** You can choose from Profile Direction, Uphill Slope Direction and Downhill Slope Direction.

**Draw Vertical Interval Labels:** This option labels the intervals of the vertical curve section. In its setup dialog, you can specify the intervals, distance from the vertical curve to put the labels, decimal places to display the interval stations and elevations, symbol settings and label settings.
Here is an example of a road profile.

![Road Profile Diagram]

**EOP Profile Setup**

This button allows you to establish the criteria for drawing and labeling Edge of Pavement (EOP) profiles:

![EOP Profile Settings Dialog]

- **Begin/End Front Curb Return:** Enter a description for the front curb return.
Begin/End Back Curb Return: Enter a description for the back curb return.

Include Road Name: Enable this control if you'd like the road name included with the edge of pavement profile.

Draw VC Labels for EOP Profiles: When enabled, this option will label vertical curves found in edge of pavement profiles.

Draw Curb Return Length Label: When enabled, this option will label the length of curb returns. Use the Setup button to specify and control the display settings.

Draw Curb Return Elevation Labels: When enabled, this option will label the elevations of curb returns. Use the Setup button to specify and control the placement and display settings.

**Pipe Crossing Labels**

This button opens Pipe Crossing and Link Label Options dialog, which contains all the settings for drawing a pipe crossing type or profile, or the pipe crossings when pipes or sewer networks in the drawing are intercepted by a profile to be drawn.

![Pipe Crossing and Link Label Options](image)

**Pipe Symbol:** Options to show pipe crossing in circle, square, or based on the pipe shape.

**Text Rotation:** Labels can be drawn either horizontally or vertically. This option becomes disabled when the *Draw Annotations with Leader* option is enabled.

**Label Prefix/Suffix:** Indicate labels that should precede and/or follow the pipe information.

**Label Decimals:** Decimal places of the labels.

**Label Station/Elevation/Size/Name/System Name:** Options to label the parameters or not.

**Station Crossings By Another Centerline:** This option will make new stations by referencing the profile to another centerline, for example a road centerline.

**Draw Pipe Crossing On-The-Fly:** When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect the pipe crossings. Any pipe crossings found would be drawn with other profiles.
**Draw Parallel Pipes Within a Swath Width:** When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect if there's any pipe segments that are within a swath width along the profile. Any pipe segments found would be drawn with other profiles.

**Draw Annotations with Leader:** When enabled, this uses a leader in conjunction with pipe labels.

**Draw Annotations with Vertical Line:** When enabled, this uses a vertical line and orientation to indicate the location of the pipe crossing being labeled.

**Show Pipe Thickness:** When enabled, this draws the pipes in profile using double lines to indicate the thickness of the pipe. The area between the lines can be cross-hatched.

**Link Label Settings:** Settings to determine how to draw link labels.
An Example of Pipe Crossings On-The-Fly

An Example of Parallel Pipes Within a Swath Width

**Lateral Connection Labels**

These settings apply for profiles create from a Sewer Network from the Hydrology module that contains lateral structures. There are several lateral data fields available for labeling. Use the Add/Remove buttons to make the list of fields to label. Use the Setup button to set the prefix and suffix for each field, and control whether the field is labeled on a separate row. There are settings to choose the symbol on the pipe at the lateral station, the text orientation, whether to draw a vertical line at the lateral station, set the label position and offset, set the text justification and whether to draw a leader from the pipe to the label.
Sewer/Pipe Labels

This button opens Draw Sewer/Pipe Options dialog.

General Tab

The sewer structure or pipe profile labels can be drawn in the following four styles:

**Draw Horiz Axis Annotations**: Labels structure or pipe profile along the horizontal axis.

**Draw Annotations Above Rim**: Creates structure or pipe profile labels above the rim of manholes.
Here is an example of using the Data Table option for the labels:

<table>
<thead>
<tr>
<th>STATION</th>
<th>3+00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>INV IN</td>
<td>996.92</td>
</tr>
<tr>
<td>INV OUT</td>
<td>995.92</td>
</tr>
<tr>
<td>RIM</td>
<td>999.76</td>
</tr>
</tbody>
</table>

**Draw Annotations Below Invert:** Creates structure or pipe profile labels below the rim of manholes.

**Draw Annotations with Leader from Rim Position:** Creates structure or pipe profile labels with a leader from manhole's rim position.

**Draw Annotations with Leader from Invert Position:** Creates structure or pipe profile labels with a leader from manhole's invert position.

**Draw Annotations with Attribute Block:** Inserts blocks with attributes for the structure or pipe labels.

Each style has a setup dialog to specify which labels are to be created and in what order. For labels with leaders, you can setup the leader styles.
Tick Mark for Station: Draws a tick mark at every station.

Project Invert In/Out Elev at Manhole Center: The Invert In/Out elevations are not the actual values, but are projected elevations to the manhole center.

Station Manholes by Another Centerline: This option will make new station for each manhole by referencing the profile to another centerline, for example a road centerline.

Draw Sump: When enabled, specify the height of the sump to be drawn into the sewer profile.

Draw Base: When enabled, specify the base height to be drawn into the sewer profile.

Label Precision: Click on the Label Precision button to set the amount of precision used for sewer station, elevation, length and slope labels.

**Manhole Tab**

On this tab, you are able to specify how to label the manhole name and how to draw the manholes.
**Draw Manhole Name:** Enable this option and select the desired geometric shape that shall circumscribe the manhole name. If selected, enter any desired prefix or suffix for the labels.

**Draw Manhole Sides Down To Invert:** Closes the manhole at pipes.

**Manhole Rim Elevation Prompt:** Ignores the manhole's rim elevation and prompts to enter new values.

**Manhole Rim Offset Prompt:** Prompts to enter the offset value and adds the offset to the manhole's rim elevation.

**Manhole Width Prompt:** Enable this option to prompt for the top width of the manhole.

**Manhole Bottom at Pipe Slopes:** Enable this option to prompt for the bottom width of the manhole.

**Draw Manhole Separate from Pipe Polylines:** Enable this option to draw the shape of the manhole as a separate polyline from that of the pipe.

**Draw Vertical Line Through Manhole Center:** Draws a vertical line through the manhole center from rim to bottom of profile grid.

**Draw Drop Across As Vertical On Uphill Side:** If a step up is used, draws this as a vertical line on the higher side of the structure.

**Drop Across Manhole:** Adds a step up to the invert-in elevation.

**Taper Format, Manhole Dimensions:** When drawing from a profile file created with the Design Sewer/Pipe Profile command, these parameters are used to define the manhole shape and dimension. When drawing from a profile created from Network in the Hydrology module with commands such as Export to Profiles, these Draw Profile settings are ignored and the dimensions come from the Network instead. The taper settings are used for transitioning between different manhole top and bottom widths. The Top Taper Offset sets the distance from the top of the manhole to the point that the taper will end. The Fixed Taper Height determines the overall length of the tapered section.

In this example image, all the manholes have Top Width of 2 and Bottom Width of 4. Manhole #1 has Top Taper Offset of 2 and Fixed Taper Height of 0. Manhole #2 has Top Taper Offset of 100 and Fixed Taper Height of 0. This large Top Taper Offset is greater than the manhole depth so that the taper runs the full length of the manhole. Manhole #3 has Top Taper Offset of 3 and Fixed Taper Height of 1.

**Pipe Tab**

Here you can choose to label pipe in a very flexible order. Each label has a setup function which specifies the label prefix and suffix, decimal places, row number and etc.
Pipe Label Position: Indicate the preferred location for pipe labels.

Labeling Method: Indicate the preferred method for determining the length of the pipe.

Pipe Material: Indicate the type of material used for the pipe.

Draw Pipe Thickness: When selected, draws pipes in profile as double lines indicating the thickness of the pipe. This option also allows for cross hatching of the double lines.

Label Pipe Distance as Station Along Horiz Axis: This option creates pipe distance labels as the station style along the horizontal axis. Click the Setup button to access the labeling method and style.

Draw Flow Arrows: Indicate if arrows should be drawn illustrating the direction of flow.

Draw Cradle Lines: If the sewer profile contains cradle data, this option would draw cradle lines above and below the pipe segments.

Draw Pipe Label as MTEXT: When enabled, text labels will be drawn as a multiline text (MTEXT) entity.

Fit Pipe Label Between Structures: When enabled, this option will ensure that pipe labels will fall within a structure-to-structure distance.

General Settings
Layers

The Layers button has the layer names for the profile lines, profile grid and general labels.

Colors

The Colors button has the colors for the profile lines, profile grid and general labels.
Text Settings

The Text Settings button has the text style and size scalers for profile grid and general labels. The size scalers are multiplied by the profile horizontal scale to determine the text size in drawing units. The Double-Click Text Link Profile Settings controls whether double-click on the profile text in the drawing brings up the Draw Profile Settings for that text or runs the action set in the CAD such as edit text.

Linetypes

The Linetypes button has linetype settings for the profile line and profile grid. There are also settings for drawing a profile legend of the profile lines.
Back

Allows you to return to the previous dialog box to alter or adjust the information it provides.

Load Settings

Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.

Save Settings

Saves all Draw Profile settings in a (.PFS) file.

Prompts (may vary based on Settings)

Polyline should be drawn in direction of increasing stations.
CL File/<Select pipe crossings on-the-fly or parallel pipes centerline>: Pick a polyline upon which to base the stationing or Type C to select an existing Centerline .CL file and then press Enter
Centerline Starting Station <0.0>: Press Enter to accept the default station value specified or Type in the beginning station then press Enter

Pulldown Menu Location(s): Civil > Profiles, Survey > Surface, Field > Roads
Keyboard Command: drawprof
Prerequisite: A profile .PRO file

Draw Profile Grid

This command plots a grid and labels the grid lines with stations and elevations. Profile grids can also be plotted along with the profile when using the command Draw Profile. Use this command to draw only the grid. The following dialog box appears:
**Direction:** Choose grid direction, either left to right or right to left.

**Station Text Orientation:** Specify whether the station text should be plotted horizontal or vertical.

**Axis Text Only:** When checked, grid lines are not drawn.

**Ticks and Axis Text:** When checked, one horizontal and vertical grid line as well as the annotations will be drawn.

**Offset Horizontal Axis Annotation:** When checked, additional space is added between the bottom horizontal grid line and the station labels in order to leave room for Horizontal Axis Elevations and sewer profile annotations.

**Text Size Scaler:** This sets the size of text used for annotation. This value is multiplied by the horizontal scale to obtain actual text size.

**Index Grid Line Layer:** Specify the layer name for index grid lines.

**Grid Text Layer:** Specify the layer name for text annotation along the horizontal and vertical axis.

**Intermediate Grid Layer:** Specify the layer name for intermediate grid lines.

**Horizontal Scale:** This sets the horizontal scale for the profile grid.

**Vertical Scale:** This scale sets the vertical exaggeration of the profile grid.

**Horiz. Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. If you use a large Text Size Scaler such as 0.2 in English units, it is best to set the horizontal text interval to twice the horizontal scale, so that the larger text will not overlap along the horizontal axis.

**Vert. Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.

**Horiz. Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.

**Vert. Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.

**Scan File to Set:** Prompts to select a profile (.PRO) file which it reads to set the values for starting and ending stations and elevations.

---

**Draw Grid with Station Text Vertical and no Offset Horizontal Axis**

![Draw Grid Diagram](image-url)
Prompts

Draw Grid dialog box
Pick Starting Point for Grid <0.0 , 500.0>: pick a point

Pulldown Menu Location: Profiles > Profile Grid
Keyboard Command: drawgrid
Prerequisite: None

Add Grid Ticks and Dots
This routine draws ticks on the axis and/or interval dots on an existing grid.

Prompts

Add Grid Ticks & Dots dialog
Specify whether to draw the ticks and/or dots, and choose their resolutions (.1 or .2). Also, make sure the grid parameters match the grid that you're working on.
Pick Lower Left Corner of Grid: pick the corner (endpoint snap is on)
Pick Upper Right Corner of Grid: pick the corner (endpoint snap is on)

Grid ticks and dots with metric stationing (no ‘+’) as set in Profile Defaults

Pulldown Menu Location: Profiles > Profile Grid
Keyboard Command: tickdot
**Add Grid Lines**

This routine draws grid lines at the specified scale and interval between the picked lower left and upper right grid corners.

![Add Grid Lines dialog]

**Prompts**

**Add Grid Lines dialog**
Make sure the grid parameters match the grid that you're working on.

**Pick Lower Left Corner of Grid:** pick the corner (endpoint snap is on)

**Pick Upper Right Corner of Grid:** pick the corner (endpoint snap is on)

**Pulldown Menu Location:** Profiles > Profile Grid

**Keyboard Command:** gridline

**Prerequisite:** A profile grid

**Adjust Profile Grid**

This command allows you to modify the profile grid parameters for a profile that is already drawn. First you pick on any entity that is part of a drawn profile. Then change any of the settings in the dialog shown here and the program will update the profile.

![Edit Profile Grid and Scale]

**Prompts**
Pick profile to edit: *pick any entity from a drawn profile*

**Edit Profile Grid and Scale dialog**

**Pulldown Menu Location:** Profiles > Profile Grid/Sheet  
**Keyboard Command:** edit_drawprof  
**Prerequisite:** A drawn profile

---

**Adjust Draw Profile Settings**

This command allows changes to be made to an existing profile, either on the Model tab or on a layout tab. These changes include all of the options that were used to create the profile originally using the Draw Profile command.

The first step in Adjust Draw Profile Settings is to choose the profile you want to change by picking any entity on the profile drawing. Once you have selected a profile in the drawing, the **Draw Profile** dialog box appears, and contains all of the settings for creating the profile. Please see the Draw Profile section of this manual for a description of these settings.

When OK is clicked at the base of the dialog box, the profile is updated in its current location.

**Pulldown Menu Location:** Profile Grid/Sheet > Adjust Draw Profile Settings  
**Keyboard Command:** reset_drawprof  
**Prerequisite:** A profile in the drawing

---

**Adjust Plan/Profile Sheet**

This command is used on a Plan & Profile sheet generated by the Draw Profile command with the Draw Sheet option selected. Adjustments can be made to the plan view, profile, or sheet itself. The command is run entirely from the Adjust Plan and Profile Sheet dialog box. Adjustment settings are defined, and then all adjustments are accomplished simply by picking the appropriate icons.

![Adjust Plan and Profile Sheet dialog box](image)

**Pulldown Menu Location:** Profiles > Profile Grid/Sheet  
**Keyboard Command:** ppsheet  
**Prerequisite:** A Plan & Profile paper space layout generated with Draw Profile command
Move Sewer Profile Labels

This command moves the selected sewer profile labels with a leader. The purpose is to clean up label overlaps. To move a label, pick any one of the text labels and the program will pick up all the other associated labels. Then pick the new location and while the pointer is moved, the program shows an outline of the label area. The program remembers the moved locations for each label so that when the sewer profile labels are redrawn, the moved locations are retained. The Restore function puts the labels back to their default position. The following graphics show the sewer profile labels before and after Move Sewer Profile Labels was used to clean up the label overlaps.
Prompts

Select sewer profile label to move (R for Restore): *Pick a sewer profile label text with leader entity*

Pick label position: *pick a point*

Select sewer profile label to move (R for Restore, Enter to end): *press Enter to end*

Pulldown Menu Location: Profiles > Profile Grid/Sheet

Keyboard Command: move_swprof_label

Prerequisite: sewer profile labels with leader

Draw Plan View Sheets

*Draw Plan View Sheets* creates layout tabs with viewports for plotting an existing centerline. These plan view sheets are sized and oriented automatically based on the centerline design.

The first step in Draw Plan View Sheets is to choose the centerline to be plotted. This may be selected from the drawing, or you may select an existing centerline (.CL) file. Once you have selected a centerline, the Sheet Setup dialog box appears, and contains all of the settings for creating the layout tabs and sheets.
Layout Name: Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the centerline plan view sheet layouts, and if the length of the centerline extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1.

Note:

- If either the Start Station in Layout Name or the End Station in Layout Name options are enabled, the Layout Name field will be disabled as the Layouts will get named automatically.

If you enter "ms" to go to model space within a Layout tab, you can pan to alter the plan view position. However, it is best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

Start/End Station in Layout Name: These options allow you to include starting and ending station in the Layout Names.

Add Layouts to Current Layout Set: This option allows you to add the layouts created to an existing layout set that was previously generated using the Layout Set Manager. You will need to specify the name of the layout set.

Block Name: This is the drawing name for the sheet to be inserted. The Set button can be used to change the block name. Carlson provides a standard plan and profile border in the form of profile.dwg located in the working folder of %AppData%\Carlson Software\..\Sup\. You may wish to revise profile.dwg to remove the grid, resize the plan viewport, and add your company logo, and re-save it as plan.dwg. Alternatively, you could add your own complete version of a sheet block/border.

Set Sheet Attributes: This button allows you to specify the values used by any attributes associated with the sheet block. These can be entered manually in the Set Sheet Attributes dialog.
You can use the Set button to the right of any field to set that field to a preset value pulled from the drawing information.

**Sheet Width:** This is the profile width, in inches, on the sheet.

**Lower Left Offset X/Y:** Indicate the offset value(s) for the insertion point of the sheet in CAD units. This option allows user-defined Block Names to be properly positioned relative to the remainder of entities placed through the Draw Profile command.

**Percent of Overlap:** Use this to set the amount of centerline shown beyond the match line on each sheet. This can make it easier to piece together sections of the centerline on separate sheets.

**Horizontal/Vertical Scale:** Set the scales to be used for the new viewport(s).

**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Draw Scale Bar in Plan View:** Adds a scale bar to the finished sheet. If this option is selected, the scale bar can be placed in any corner of the sheet using the Draw Position drop down.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view. Click the North Arrow Settings button to establish the desired North arrow and placement information.

**Draw Plan View Borders in Model Space:** This draws the borders in Model Space which can be useful or orienting text and other labels to the orientation of the sheet. When this option is selected, use the Layer text box or Set button to choose the layer on which the borders will be drawn.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.

When OK is clicked at the base of the dialog box, the layout tabs are created if necessary, and the sheets are drawn.
Horizontal Axis Elevations

This command labels the elevations of a profile along the bottom horizontal axis at a user-specified interval. It requires an existing grid and profile. The profile can be read from either a .PRO file or from a profile polyline on the grid. This polyline must be drawn in the direction of the grid. There are more labeling options when using the screen polyline method.

In the dialog, you can set the layer name, style, size and decimal places for the labels. Two profiles can be labeled at once to handle existing and final profiles in one step (see graphic). When labeling two profiles with the "File" method (recalling a profile), use the "L" justification for the first set of horizontal axis elevations, and use the "R" justification for the second set. One convention is to label the existing profile to one decimal place and the final profile to two decimal places. When labeling only one profile, use the center justification. When using two profiles from the "Screen" selection method, there is an option to also label the elevation difference between the profiles. The Label Between Elevations option chooses between labeling the values in the order of existing elevation, cut/fill and final elevation or in the order of existing elevation, final elevation then cut/fill. The Skip Elevation Labels option will label only the cut/fill and not the elevations.
Prompts

Read Profile from a File or from the Screen (File/<Screen>): press Enter
Plot Elevations on Horiz Axis dialog
Make sure the grid starting station and elevation match the grid that you're working on.
Pick the existing grade (Enter for none): pick a profile polyline on the grid
Pick the final grade (Enter for none): press Enter
Alignment of text (<Left>/Center/Right)? C This prompt occurs only in the "File" selection method.
Pick Lower Left Grid Corner: pick the corner (endpoint snap is on)

Pulldown Menu Location: Profiles > Label Horizontal Axis
Keyboard Command: horelev
Prerequisite: Profile grid with a profile polyline

Horizontal Axis Crossings

This purpose of this command is to draw ticks on the horizontal axis of the profile at station locations where the centerline intersects selected plan view polylines. It requires a grid, profile and an existing CL file, as well as user-specified values entered into the dialog. The profile can be read from either a .PRO file or from a profile polyline on the grid. This polyline must be drawn in the direction of the grid. In the dialog, you can set the direction of the grid, the horizontal scale and the starting station of the grid. You can also determine the Text Size Scaler, Text Layer name and the Marker Size Scaler. The command line offers the option to choose the existing centerline (.CL) file. You enter "C" and a dialog appears where you may select the file.
Prompts

Horizontal Axis Crossings dialog Fill in values.
Polyline should have been drawn in direction of increasing stations.
CL File/Select polyline that represents centerline>: pick polyline

Plan view showing crossing
Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs.

Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

Prompts

Layer Name for 3D Polyline <3DPROF>: press Enter
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing.
Enter the starting station <0.0>: press Enter
Select Profile File
Starting station of centerline <0.0>: press Enter
Erase centerline (Yes/<No>)? Y This option will erase the original 2D polyline centerline.
Profile To Points

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC's and PT's) can be stored in the point description depending on user settings.

Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.  
Interval On Line Segments: Specify station interval for line segments.  
Interval On Curve Segments: Specify station interval for curve segments.  
Station to Begin Intervals: Specify station to start intervals.  
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.  
Create Points on Centerline: When checked, points will be created on the centerline.  
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.  
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.  
Vertical Offset of Profile: Specify the vertical offset. Enter zero for no vertical offset.  
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.  
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be DESIGN 0+63.37.  
Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.  
Centerline by: Click either Polyline or CL File.  
Type of Centerline: Click either Roadway or Railroad.  
OK: Specify files.

Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.  
Select profile centerline polyline: pick a polyline  
Starting station of centerline <0.0>: press Enter  
Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing. With this option, the first centerline is used for locating the points and the second reference centerline is used for locating the profile stations. So the first centerline represents where the points are created (ie. the edge of pavement) and the second centerline represents the profile location (ie. the road CL).  
Choose Profile to Process dialog Specify a profile name.  
Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.  
Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.
Points created along profile centerline using elevations from the above road profile

**Keyboard Command:** pro2pts  
**Prerequisite:** A .PRO file and a centerline polyline

### Profile Report

This command creates a summary report of generic, road, crossing, pipe and sewer profiles using a profile file (.PRO file). The report is generated in the standard report viewer which can print the report, save it to a file or draw it on the screen. The different types of profiles have different report options.

For roadway profiles, Report Sag and Crest Stations will calculate and report sag and crest stations and elevations. Report Stations at Centerline Points will prompt the user for a centerline file (.CL file) and report stations and elevations at horizontal PC and PT points. Report Cut/Fill from Second Profile will compute and report the elevation difference between the subject profile and a second reference profile. Report Min/Max Cut/Fill reports the stations and amounts for the min and max cut and fill between the road and reference profiles. Report Station/Elevation at Interval will calculate and report stations at the specified interval in addition to other points. Report Elevation to Vertical Offset creates and additional elevation column in the report. The differential amount for this column is specified by the user in the Vertical Offset window. The Use Report Formatter option runs the report through the report formatter where you can choose which fields to report and the report order as well as output to Excel or databases.
For sewer profiles, the Report Method chooses between reporting the slopes and pipe distances between manhole centers or from the outside manhole edges for the actual pipe dimensions. The Report Pipe Size Summary option reports the total pipe length for each different pipe size. The Station By Another Reference Centerline option reports the sewer stations using a reference alignment besides the sewer alignment. For example, this option can be used to report the sewer stations based on the road centerline. When this option is on, the program will prompt for both the sewer centerline and the reference centerline. The program first finds the position of the sewer station along the sewer centerline and then finds the station of the nearest perpendicular offset along the reference centerline.

Prompts
Specify a Profile File dialog Choose the .PRO file.
Profile Report dialog Make selections, click OK.
If a vertical offset is entered, a second column of elevations is reported.

Sample Profile Report:

Profile Report
Road Profile
Station Elevation Type VertCurve Distance Slope Desc
0+00.00 88.08 0.00
1+00.00 94.39 6.45%
2+00.00 100.84 6.45%
3+00.00 107.29 6.45%
3+73.78 112.05 PVC 371.48 6.45%
4+00.00 113.68 6.00%
5+00.00 118.82 4.27%
6+00.00 122.22 2.54%
6+23.78 128.18 PI 350.00 250.00 6.45%
7+00.00 121.26 -6.10%
7+23.78 119.50 PVT 100.00 -8.67%
7+75.71 115.00 0.00 51.93 -8.67%

Pulldown Menu Location: Profiles
Keyboard Command: preport
Prerequisite: A .PRO file

Polyline Slope Report

This command calculates and labels the slope of a line, polyline segment, an entire polyline, or pair of points, as drawn on a profile. The command starts with the Slope Report Options dialog.

**Horizontal Scale:** Specify the horizontal scale of the profile.
**Vertical Scale:** Specify the vertical scale of the profile.
**Text Size Scaler:** Specify the text size scaler.
**Decimals:** Specify the display precision for the slope labels.
**Label Symbol:** When checked, the degree symbol or percent sign will be used in the label.
**Label Arrow:** When checked, a slope direction arrow will be included.
**Label Minus Sign:** Will label a minus sign on negative slopes.
**Label Format:** Specify how to label the profile slopes. The automatic settings means to use a percent label for any slope less than 10%. and a ratio for any slope greater that 10%.
Label Method: Choose to label the entire profile at once or to pick individual segments.
Reduce Profile Points: When checked, the number of labels created on the profile will be reduced based on the Offset Distance value. Applies only to the Entire Polyline selection option.
Offset Distance: Specify maximum offset between profile vertices. Only available when Reduce Profile Points toggle is checked on.

Prompts

Slope Report Options dialog box
Points/<Select line or polyline to list-label>: pick a polyline
Slope Distance > 600.33 Horizontal Distance > 600.00
Elevation Difference: 20.00 Slope Ratio: 30.00:1 Slope Percent: 3.33
Starting point of label ([Enter] for none): pick a point
Points/<Select line or polyline to list-label>: press Enter If you choose P for points, you go into the Points mode and can label the slope of any pair of screen picks on the profile.

Keyboard Command: llg
Prerequisite: A profile grid and profile polyline

Station-Elevation-Slope Report

This command calculates the elevation and slope along a profile at user specified stations or intervals. The routine allows three types of profile input options: Profile File (an existing .PRO file), Screen Profile (existing grid and polyline profile), or None (allows you to specify station-elevation points without referencing a profile). If the Screen Profile option is used, the profile polyline direction must match that of the stationing on the grid.

There are two Output options: Report and Label Profile. The Report option will send the output data to the standard report viewer, which can then be printed, saved to a file or plotted in the drawing. The Label Profile option will create text on the existing grid and polyline profile. With either option, the user will be prompted to enter or pick the station to report unless the Report at Interval option is checked on. In this case, the reporting will be done automatically at the interval specified. With the Label Profile option, the user has the additional options for defining the data to be labeled (Station, Elevation, Both or None), the slope format and the vertical position of the text on the grid.

This command can also be used as a profile inspector. As you move the cursor around, the station, elevation and profile grade are displayed in a real-time window, unless you specify the more automatic "report at interval" method. If Prompt for snap is set on (available in non-interval mode), then when a point on the profile is picked, you have the opportunity to snap to an even 1, 5 or 10 stations.
Prompts

Station-Elevation-Slope Report Options dialog
Profile Settings dialog Check that these parameters match the grid.
Pick Lower Left Grid Conner <5177.48,5034.10>[end on]: pick the corner (endpoint snap is on)
Pick profile polyline: pick the profile polyline
Range of Stations > 0.0 - 312.43
Station > 0+00.00 Elevation > 364.00 Slope > 4.00%

Pick the vertical position for the text: pick a point to place the text
Station > 0+50.00 Elevation > 366.00 Slope > 4.00%
Station > 1+00.00 Elevation > 368.00 Slope > 4.00%
Station > 1+50.00 Elevation > 369.12 Slope > 0.50%
Station > 2+00.00 Elevation > 368.46 Slope > -3.08%
Station > 2+50.00 Elevation > 366.92 Slope > -3.08%
Station > 3+00.00 Elevation > 365.38 Slope > -3.08%
Picked method with Slope set to None

Interval method with Slope in Percent

**Pulldown Menu Location:** Profiles  
**Keyboard Command:** staelv  
**Prerequisite:** Profile grid with profile polyline or .PRO file

---

**Sag & Crest Report**

This command will calculate the high and low point (sag and crest) on the vertical curves defined in the specified road (.PRO) profile file. Plotting the calculations in the drawing is optional. A profile grid must already be drawn to use the plotting option. The sag and crest are only labeled if the respective low and high points occur on a vertical curve.
Prompts

Report only/<Plot calculations>: press Enter
Profile Settings dialog If you're using the plot option, make sure these parameters match your grid.
[end on]Pick Lower Left Grid Corner <0.00,0.00>: pick this point
Number of decimal Places <2>: press Enter

Sag & Crest Report
SAG Station> 3+71.80 Elevation> 1000.00
CREST Station> 9+40.20 Elevation> 1027.19

Pulldown Menu Location: Profiles
Keyboard Command: sagcrest
Prerequisite: A road profile

Pipe Depth Summary
This command reports the horizontal distances for the range of depths comparing a surface profile to a trench, pipe or sewer profile. There is an option to use two surface profiles and the program will use the minimum of the two depths. In addition to the report, the depth ranges can be labeled along the profile in the drawing.

The simplest of applications of this command, comparing a sewer profile to a surface profile and reporting the depth summary according to the specified Depth Zones, is shown below.
Use Trench Template for Volumes: Trench templates are made using the command Input-Edit Trench Template within the Profile Utilities "flyout". Trench earthwork volumes are then computed.

Report Backfill Volumes: Available if trench templates is clicked on.

Use Rock Strata Profile: If clicked on, the Rock Profile can be entered in the lower portion of the dialog, and if the pipe invert is below rock surfaces along any segment, rock linear feet will be reported, in the same depth categories as used for trench depths. In the example shown below, if rock depth is uniformly 5 feet below surface elevation, in the form of a rock profile, rock quantities are 348 feet of 0-2 feet depth of rock trenching.

Use 2nd Surface Profile to Minimize Cut: If the final grade is below existing grade, in those areas, it saves trenching work to first do the cut to final grade, prior to filling over existing grade in areas of fill. Then trench depths are minimized. This option, if clicked on, computes trench depths to the minimum of the two specified surfaces, and activates the 2nd Surface Profile option in the lower portion of the dialog.

Extend Shorter Profile to Longer Profile: This option will extrapolate the starting and ending stations of the shorter profile to match the longer profile.

Draw Zone Dimensions on Profile: The depth zones will be annotated along the horizontal axis of a profile drawing with this option.

Report Manhole Depth Summary: This leads to the depth summary report.

Depth Zones: These zones are for reporting the pipe range of depth. The depths should be entered in lowest to highest order. Use the Next and Back buttons to move between the 20 possible depth values.

Prompts

Pipe Depth Options dialog
Pick lower left grid corner [int on]: pick the profile grid corner
Pick vertical position for dimensions: pick a point below the profile grid
Pulldown Menu Location: Profiles
Keyboard Command: pideep
Prerequisite: Two profiles, one for the surface and one for the pipe invert elevation

Label Profile On Centerline
This command labels a road profile on a centerline in the plan view. First you are asked to select a road profile and a centerline. Then on the Label Profile On Centerline Settings dialog, you need to choose which labels to draw. The left list shows the available labels to draw, the right list shows the label that have been chosen to draw. Add button moves the highlighted label on the left list to the right list, Remove button moves the highlighted label on the right list to the left list, and Setup button allows you to edit the options of how to display the highlighted label in the plan view.

The available labels include:
PVC, PVI, PVT, High and Low Points: To label the station and/or elevation of the profile at these points.
Slope: To label each different slope in the profile.
Station At Interval: To label the stations along the centerline at a station interval.
Elevation At Interval: To label the profile elevations at a station interval.

On the point label edit dialog, you may choose to display either the station or elevation, or both, or neither of them, and specify their prefix or suffix. If you choose to label both the station and the elevation, the labels are drawn in two lines by default, unless you elect the option to Label Station and Elevation on Same Line. When the screen is twisted, some of the labels would possibly be drawn upside down, the Flip Texts for Twist Screen option flips the text to the proper direction. Draw with Symbol setting draws a symbol at the position of the label. Next, you would select from a list the Symbol Name, Layer Name, Style Name and Color for displaying the label. There are two Label Position settings: Above and Below the centerline, and three Label Orientation settings: Horizontal, Parallel and Perpendicular. Text Size Scaler and Symbol Size Scaler determine the size of the text label and symbol label respectively in plan view.

The slope label edit dialog is very similar to the point label edit dialog, the big difference is the Arrow Direction. There are four arrow directions: Centerline Direction, Uphill Slope Direction, Downhill Slope Direction and Away from PVI.
An example dialog for editing PVC Point Label

An example dialog for editing Slope Label

Here's a site design example shown below, where a profile is labeled on the centerline. The PVI labels are above and parallel to the centerline, the PVC and PVT labels are below and perpendicular to the centerline, and the slopes are above and perpendicular to the centerline, their arrows are in the downhill slope direction.
If the road profile is modified by a Carlson program, the profile labels will be updated automatically. When you double-click on one of the labels, a dialog of the labeled PVI section will pop up for editing. In the sample dialog show below, you can modify the station, elevation, and other parameters of the PVI point. **Pick** button allows you to pick on the screen to get the station. **Through Pt** button opens a dialog where you can define a point on the profile to pass through the fixed station and elevation. When click on **Spreadsheet Editor** button, the road profile editor is opened for you to edit road profile.
Profile ID

This command reports the profile file name, horizontal scale and vertical scale that was used to draw the selected drawing entity. Simply pick a profile entity in the drawing and the profile file name is reported in the command text window. The profile must be drawn in Carlson by completing the Draw Profile command (without aborting the command by pressing Esc).

Prompts

Select profile entity to identify: *pick an entity*
Horizontal Scale: 50.0 Vertical Scale: 10.0
Profile Name: sewer.pro
Select profile entity to identify: *press Enter to end*

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: profid
Prerequisite: Profiles drawn on the screen
Review Profile Links
This command shows a list of all the profile links that the program knows about in the current drawing. These links are between the profile files and the drawn profiles in the drawing. You can use the Remove button to remove links for any obsolete profiles or if you don't want to link a certain profile.

**Pulldown Menu Location:** Profile->Profile Utilities  
**Keyboard Command:** profdict  
**Prerequisite:** None

**Input - Edit Trench Template**
This command lets you create a new trench template or modify an existing trench template. It prompts you the **Input-Edit Trench Template Dialog**. If you are modifying a trench template, click the **Load** button on the dialog to open a trench template file and display the template data on the dialog. Enter the dimensions of the trench: bottom offset, trench width and vertical side height. The Edit Trench Benches button will bring up the below dialog, and allows you to enter in up to four benches into your trench.

![Edit Trench Benches Dialog](image)

There are three methods for entering the cut slope, Percent, Ratio and Degree. Choose one of the methods and enter the slope value. There are three trench bottom backfill layers that can be defined. Enter the layer label in the material name field, the depth of the layer in the thickness field. Click Save or SaveAs to save the template information in a .tch file, and Click Exit to quit this command.
Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: make_trench_tpl
Prerequisite: None

Draw Typical Trench Template

This command draws a trench template on the screen. After you select a trench template file (.tch) to draw, a Typical Trench Template Dialog is prompted for entering the layer name, drawing scale, text size scalar, pipe size and selecting how many decimal points you want. You can also hatch the backfill on the drawing. Click OK to draw the template at the position that you pick on the screen.

Prompts

Pick position to draw template: pick a position on the screen
**Point Placement on Profile**

This command has two methods for placing points on a profile. One method places symbols on an existing profile at picked points or at entered stations and elevations. The station and elevation of the current position of the crosshairs is displayed in the lower right of the screen menu. The symbols can be any of the point symbols or a special pipe crossing circle that will become an ellipse to represent any vertical exaggeration.

The other method will draw an entirely new profile based on points that are defined in a coordinate (.CRD) file. The elevations of the profile come from the elevation of the points and the stations come from the station value in the description field of the point. Points without the station value in the description field and points with a zero elevation are ignored. In addition to drawing the profile, the points are plotted on the profile along with their point number, elevation, and description. The station text in the point descriptions can be generated with the *Calculate Offsets* command in the Centerline menu. Using SurvCE, the Carlson data collection program, you can gather points in the field and store their station as the beginning of the description, and these points would then plot as a profile using this command.

Prompts

**Place points from CRD file or pick points (File/<Points>)?** *pick*

**Profile Settings dialog**

*Pick lower left grid corner <5000.0,5000.0>: pick the grid corner*

*Enter station or pick a point (Enter to End): 75*

*Elevation of point: 565*

For CRD File option:

*Select CooRD File to Read*
This is the source file that contains the profile information.

**Range of Point Numbers to use (A for All)** <A>: press Enter

**Wildcard match of point description** <*>: press Enter

**Plot Full or Abbreviated text (Full/<Abbrev)?** Full

**Range of stations:** <134.41 - 938.31>

**Starting Station** <134.41>: press Enter

**Ending Station** <938.31>: press Enter

**Profiles Settings Dialog**

**Starting/Datum Elevation of Profile** <495.0>: press Enter

**Pick Starting Point For Axis** <100.0,495.0>: press Enter

Sample contents of .CRD file:

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>4368.47</td>
<td>4250.26</td>
<td>502.31</td>
<td>BC1+34.41L64.24</td>
</tr>
<tr>
<td>4</td>
<td>4406.95</td>
<td>4273.95</td>
<td>505.26</td>
<td>BC1+78.08L75.85</td>
</tr>
<tr>
<td>5</td>
<td>4427.67</td>
<td>4416.11</td>
<td>498.21</td>
<td>CB2+96.13R1.25</td>
</tr>
<tr>
<td>6</td>
<td>4436.55</td>
<td>4549.39</td>
<td>509.87</td>
<td>TP4+33.54R32.58</td>
</tr>
<tr>
<td>7</td>
<td>4566.77</td>
<td>4795.20</td>
<td>515.50</td>
<td>MH7+07.05L55.04</td>
</tr>
<tr>
<td>8</td>
<td>4572.69</td>
<td>4996.60</td>
<td>520.14</td>
<td>MH8+88.55R43.18</td>
</tr>
<tr>
<td>9</td>
<td>4446.17</td>
<td>4419.49</td>
<td>503.65</td>
<td>CM3+08.11L13.03</td>
</tr>
<tr>
<td>10</td>
<td>4506.57</td>
<td>4814.72</td>
<td>505.00</td>
<td>EPL7+04.50R8.18</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Profiles > Profile Utilities

**Keyboard Command:** ptpro

**Prerequisite:** A .CRD file including points with elevations and station information in the description field
**Draw Single Manhole**

This command creates a single manhole from user selected points at the desired bottom and top locations of the manhole. The user specifies the horizontal and vertical scales, layer and drop across manhole. Other options include the manhole top and bottom width, top taper offset and the fixed taper height. The Top Taper Offset sets the distance from the top of the manhole to the point that the taper will end. A 2-foot offset on a 7-foot manhole is shown below. The Fixed Taper Height determines the overall length of the tapered section.

![Manhole Settings](image)

**Prompts**

**Manhole Base Point:** *pick the invert elevation point*

**Manhole Top Rim Point:** *pick the surface point*

**Pulldown Menu Location:** Profiles > Profile Utilities

**Keyboard Command:** manhole

**Prerequisite:** None
Best Fit Profile

This command processes an input profile that has data points at an interval and creates a best-fit profile with tangents and vertical curves. Each tangent segment in the profile is calculated by the best-fit line least-squares method and each vertical curve is determined by calculating vertical curve lengths between the specified Minimum and Maximum Vertical Curves at the Vertical Curve Resolution and choosing the length with the smallest residuals. The input profile represents the surveyed of the existing profile. One method to create this input profile from survey point data is to use Triangulate & Contour to make a TIN surface from the points and then use Create Profile From Triangulation Surface.

In the process options dialog, the Snap Tolerance is the max offset from the point to the profile which is used for finding the best-fit tangent segments. The Minimum and Maximum Vertical Curve values control the range of possible vertical curve lengths. The Vertical Curve Resolution is used to round the resulting length to this value. The Hold Start and End Elevation options keep the original profile elevations for matching an existing road. For Profile Type, Leveling keeps the best-fit profile from going any lower than the original profile, and Milling keeps the best-fit profile from going any higher than the original profile.

The residual for each point is the elevation difference from the point to the best-fit profile. The results are shown in a dialog and you can toggle each point for whether to include in the calculations. Points that are toggled off are not used for calculating the profile but are still used in the residual report. The Remove function removes the point from both calculation and residual reporting. After picking OK on the results dialog, the program prompts for the profile to create with the best-fit results.

This example Draw Profile shows the input profile and the best-fit profile along with elevation difference labels between the input profile break points and the best-fit profile.
Prompts

Select Profile to Process Pick the input profile
Best-Fit Profile Options Dialog Set processing options
Best-Fit Profile Results Dialog Review results and toggle points on/off
Select Profile to Write Specify the output profile

Pulldown Menu Location: Profiles->Profile Utilities
Keyboard Command: bestpro
Prerequisite: Profile to processc

Merge Profiles
This command combines a range of stations of one profile and a range of stations of a second profile. The stations and elevations in these two ranges can be stored in a new file or overwrite an existing profile. Both profiles must be the same type: generic, road, pipe, or sewer.

Prompts
First Profile to Merge Select a profile.
Second Profile to Merge Select a profile.
Range of first profile stations to use <0.0 - 400.0>: press Enter
Range of second profile stations to use <400.0 - 800.0>: press Enter
Profile file to Save dialog box

Ranges can overlap, as shown below:
Range of first profile stations to use <0.000 - 471.214>:
Range of second profile stations to use <450.000 - 480.000>:
In the case of overlap, all non-matching stations and elevations in the two sets of profile ranges will be used in the final profile. If matching stations are found, the elevations of the first and second profiles will be averaged.

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: mergepro
Prerequisite: Two profiles

Average Profiles
This command averages up to four profiles and stores the resulting profile into a user-specified file name. Profiles that don't share the exact profile range will be projected to match the low and high stations in the selected profiles,
after which the averaging will be computed.

Prompts

1st Profile file to Average dialog Specify a profile file.
2nd Profile file to Average dialog Specify a profile file.
3rd Profile file to Average dialog Hit Cancel to stop selecting profiles.
Choose Profile to Write Specify a profile file.

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: avgpro
Prerequisite: Two or more profile files

Draw Pipe 3D Polyline

This command creates a 3D polyline that represents a pipe. The points can be either picked on screen or specified by point number in the current coordinate file. This command is a convenient way to make 3D polylines that can become "pipe polylines" used for capturing their profile positions, leading to circular or elliptical or even square plots of the pipes or culverts within Draw Profile. However, this command is not required nor sufficient to make a pipe polyline useful in the Draw Profile command. Pipe polylines are made only by converting 3D polylines into pipe polylines using the adjacent command, Assign Pipe Width to Pline.

Prompts

Layer Name for 3DPoly <PIPE>: press Enter
Prompt for elevations (.XY filter) (Yes/<No>)? Y for yes
Undo/<Pick point or point numbers>: pick a point
Elevation <0.0>: 554.12
Undo/<Pick point or point numbers>: pick a point
Percent slope/Ratio slope/Elevation <0.0>: 553.72
Undo/Close/<Pick point or point numbers>: press Enter
Draw another 3D polyline (Yes/<No>)? press Enter

Pulldown Menu Location: Profile->Profile Utilities
Keyboard Command: drwpipe
Prerequisite: None

Assign Pipe Width to Polyline

This command attaches a pipe width to one or more polylines. Any polyline can be used, but it should be a 3D polyline that represents the elevations of the pipe. Pipe width is used in commands such as Profile from Pipe Polylines and Section Points from Pipes commands.
Prompts

Select polyline: pick a polyline
Enter pipe width (in): 18
Set pipe width for 1 polylines.
Select polyline (Enter to End): press Enter
Pulldown Menu Location: Profile->[Profile Utilities
Keyboard Command: plwidth
Prerequisite: A polyline

Profile Offset Text

This command draws station/offset and description text for points along a centerline polyline at a picked vertical position on the screen. It works well when used on combined Plan and Profile sheets, where the offset text can be plotted in the profile portion. The text is drawn vertically and is positioned horizontally at the station of the centerline. The station and offset of the point can optionally be included in the text. The points can either be picked or specified by point number. After picking the point, a text editor allows you to type in additional text for the label. For centerlines that are not roughly East-West, use Twist Screen under the View pulldown to re-orient the centerline to a near horizontal position on the screen. Only the "pick point or point number" option will display the edit box for the description.

Include station-offset in label: When clicked on, the calculated station and offset text is plotted.
Full or Abbreviated: The abbreviated form leaves off the even 100 feet in front of the stationing, and saves some space. Station 14+50.23 would plot as +50.23.
Label Left and Right Offsets (Together or Separately): The "Separately" option will ask for a horizontal alignment point for left and another for right offsets. Otherwise offsets will be labeled along one horizontal alignment based on one pick.

Text justification (Left or Right): Left plots down the screen and right will plot up the screen.

Label Prefix: Will place this prefix in front of the station and offset or entered text for the picked position. For example, the word "Sta." could be added as a prefix, leading to a plot such as Sta. 14+50.23.

Label Suffix: Will append this suffix to all text for each picked position.

Prompts

Profile Offset Text Dialog make choices, click OK
Polyl ine should have been drawn in direction of increasing stations.
CL File/<Select polyl ine that represents centerline>: pick the centerline
Starting station of centerline <0.0>: press Enter
Pick horizontal alignment for text: pick a point
Pick point or point number (SS for Selection Set, Enter to End): pick a point
Profile Offset Text dialog
Pick point or point number (Enter to End): press Enter

Profile Offset Text dialog

Prompts

Profile Offset Text along a centerline

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: protext
Prerequisite: A centerline polyline

Label Profile Differentials
This command labels the elevation difference between two profiles at specified stations. The text label is drawn along the polyline centerline in plan view. Cut is labeled as negative and fill as positive.

Prompts

Existing Ground Profile dialog Specify a profile file to read.
Final Surface Profile dialog Specify an existing profile file to read.
Select centerline polyline: Pick a polyline. This represents the centerline and should be drawn in the direction of increasing stations.
Starting station of polyline <0.0>: press Enter
Label all polyline vertices (<Yes>/No)? press Enter This option will label the elevation difference at the stations of each point on the polyline centerline.

Pick points to label (Yes/<No>)? press Enter This option allows you to pick points along the centerline to label.

Prompt for text position (Yes/<No>)? press Enter This option allows you to pick the position of each elevation difference label. Otherwise the text is automatically centered at the point on the polyline.

Text size <4.00>: press Enter

Pulldown Menu Location: Profiles > Profile Utilities

Keyboard Command: prodiff

Prerequisite: Two profile files

Label Sewer Laterals

This is a command to label, in plan view, the sewer laterals in linear feet. This includes a station distance from a known starting station on the main line, as well as the length of the lateral itself from the main sewer line to the property. You may optionally include a prefix and/or suffix for both the station and lateral labels.

Prompts

Label Sewer Lateral dialog Specify your preferred values.

Pick centerline/polyline that represents a sewer: pick an entity

Starting Station of the sewer <0.0>: press Enter

Pick a lateral intersection point (Enter to end): pick an intersection point

Pick a lateral to label: pick entity
**Restricted Grade Design**

This command calculates the length of vertical curve required if the grade change is restricted to a rate of change per 100 feet/units.

**Prompts**

- Percent of Grade + for up hill - for down hill.
- Line select/Percent of grade in <2.0>: L
  - [nea on] select Line that defines grade in: *pick the line*
  - Slope Distance > 900.89 Horizontal Distance > 900.00
  - Elevation Difference: -40.00 Slope Ratio: -22.50:1 Slope Percent: -4.44
  - Line select/Percent of grade out <2.0>: 2.5
- Percent of grade change restriction per 100 linear units <2.0>: *press Enter*
  - Required length of vertical curve > 347.22

**Calculate Intersection Point**

This command is a profile utility that is used to find the intersection from two points and given slopes.
**Pulldown Menu Location:** Profiles > Profile Utilities  
**Keyboard Command:** calc.pro.pi  
**Prerequisite:** None

### Sight Distance Design

This command computes the length of vertical curve required for a user-specified sight distance, grade in, and grade out. The object height and eye height may be set using the *Profile Defaults* command.

**Prompts**

- **Percent of Grade + for up hill - for down hill.**
- **Line select/<Percent of grade in <2.0>>:** L
- **Select Line that defines grade in:** pick the line
- **Slope Distance > 600.33 Horizontal Distance > 600.00**
- **Elevation Difference: 20.00 Slope Ratio: 30.00:1 Slope Percent: 3.33**
- **Line select/<Percent of grade out <20.0>>:** -2.22
- **View Table/<Required Sight distance <450.0>>:** 450
- **With SD<VC, Required Length of Crest Vertical Curve> 846.41**
- **K Value > 152.35**

**Pulldown Menu Location:** Profiles > Profile Utilities  
**Keyboard Command:** vcsd  
**Prerequisite:** None

### Plot VC from Tangents

This command plots a vertical curve by selecting the tangent grade line in, and then selecting the tangent line out. The vertical curve is drawn in the current layer.

**Prompts**

- **Select Line or polyline that defines grade in:** pick the line
- **Slope Distance > 600.33 Horizontal Distance > 600.00**
- **Elevation Difference: 20.00 Slope Ratio: 30.00:1 Slope Percent: 3.33**
- **Select Line or polyline that defines grade out:** pick the line
- **Slope Distance > 900.22 Horizontal Distance > 900.00**
- **Elevation Difference: -20.00 Slope Ratio: -45.00:1 Slope Percent: -2.22**
- **View Table/K value/Sight distance/<Length of Vertical Curve <450.000>>:** 350
- **With SD<VC Length, Crest Sight Distance> 289.37 K Value>63.00**
Enter Roadside Ditch

With this command you enter station and elevation profile data and pipe data which is stored in a file and can then be used by Draw Roadside Ditch. The roadside ditch consists of ditch, pipe and road profiles for the left and right side of a road centerline.

The program first asks whether to read an existing file. This option allows you to add data to an existing file so that you don't have to enter all the data in one run. Before entering the profile data, the program asks for the names for the profiles on the left and right side such as shoulder and edge of road. There can be any number of named profiles. Ditch and pipe profiles do not need to be named because the program always includes these. Along with the profile name, the program also asks for a layer name to use with each profile. The layer name is used in Draw Roadside Ditch to put the profiles in different layers that can give the profiles different colors and linetypes.

Then the program begins a cycle of asking for stations and elevations. First you need to specify whether the next data is for the left or right side by entering L or R. Then enter the station followed by the profile type (either Ditch, Pipe or Roads). The ditch profile type prompts for the ditch elevation. The pipe profile type prompts for pipe elevation, ending pipe station and elevation, pipe size, pipe type, and data about what the pipe is going under. The roads profile type prompts for the elevations for each of the named profiles. If there is no elevation for one of them, just press Enter. Once all the station and elevation information is entered, enter End at the next station prompt. Then specify a file to save the roadside ditch data. The file has a .RDS extension and is a text file that can be edited if necessary.

Prompts

Add to existing roadside file (Yes/No)? press Enter
Left profile name or Enter for none: EDGE OF ROAD
Layer name for EDGE OF ROAD <ROAD1>: press Enter
Additional Left profile name or Enter to continue: LT. SD. SHLDR.
Layer name for LT. SD. SHLDR. <ROAD2>: press Enter
Additional Left profile name or Enter to continue: press Enter
Right profile name or Enter for none: CL OF ROAD
Layer name for CL OF ROAD <ROAD1>: CLINE
Additional Right profile name or Enter to continue: EDGE OF ROAD
Layer name for EDGE OF ROAD <ROAD2>: ROAD1
Additional Right profile name or Enter to continue: RT. SD. SHLDR.
Layer name for RT. SD. SHLDR. <ROAD3>: ROAD2
Additional Right profile name or Enter to continue: press Enter
Right/Enter Left station <0.00>: 1305
Assign (Ditch/Pipe/Road)? R
EDGE OF ROAD elevation or Enter for none: 31.2
LT. SD. SHLDR. elevation or Enter for none: 30.8
End/Undo/Right/Enter Left station <1305.00>: press Enter
Assign (Ditch/Pipe/Road)? press Enter
Enter ditch elevation: 29.2
End/Undo/Right/Enter Left station <1305.00>: 1307
Assign (Ditch/Pipe/Road)? P
Enter pipe elevation: 28.48
Enter ending pipe station: 1318
Enter ending pipe elevation: 28.45
Pipe size in inches <15.0>: press Enter
Pipe name <RCP>: press Enter
Enter flare width: 2
Enter flare length: 10
Drive type <TOP CONC. DWY.>: press Enter
Drive id <100>: 211
Drive elevation: 30.79
Drive starting station <1307.00>: press Enter
Drive ending station <1318.00>: press Enter
End/Undo/Right/Enter Left station <1307.00>: R
End/Undo/Left/Enter Right station <1307.00>: 1321
Assign profile (<Ditch>/Pipe/Road)? press Enter
Enter ditch elevation: 30.2
End/Undo/Left/Enter Right station <1321.00>: E
Dialog to Specify a File to save the entered data.

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: rdside1
Prerequisite: None

**Draw Roadside Ditch**

This command draws the left and right side profiles for a road as entered and stored in a file made by Enter Roadside Ditch. The profiles are drawn on a special profile sheet. To customize this profile sheet, use AutoCAD to modify the drawing ROADSIDE.DWG in the Carlson\SUP directory.

**Prompts**

Choose a Roadside Ditch file to draw
Horizontal scale <10.0>: 5
Vertical scale <1.0>: press Enter
Grid horizontal label interval <50.0>: press Enter
Starting station to draw <1026.00>: press Enter
Ending station to draw <1320.00>: press Enter
Pick grid location: pick a point

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: rdside2
Prerequisite: A Roadside Ditch file (.RDS)

**Profile Conversions**

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.

**Import Columnar Text**

Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.
Import CAiCE Profile

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: caice2pro

Import Leica Profile

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

Choose Leica/Wild File to Read dialog Select existing file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: wildpro2

Import MOSS Profile

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

Choose MOSS Profile File to Read dialog Select existing file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: moss2pro

Import Softdesk Profile

Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro2

Import Sokkia/SDR Profile

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.
Import Spanish ALZ Profile

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

Choose CLIP File to Read dialog Select existing .ALZ file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: sdr2pro

Import Spanish RAS Profile

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

ISPOL File to Read dialog Select existing .RAS file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: alz_to_pro

Import Terramodel Profile

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: tm2pro

Export Softdesk Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
Section Menu

The Sections menu shown below has commands for creating, drawing and reporting sections. All commands are described in this section except for Polyline Slope Label/Report which is described under the Profiles section.

**Input-Edit Section Alignment**

This command will create or append to a section alignment file which is stored as a Multiple Cross Sections (.MXS) file. This file contains the coordinates that define the center and endpoints of section lines and is a requirement of many section commands such as Sections from Surface Entities and Sections to 3D Polyline. The section alignment defines the stations along a centerline and how far left and right to create cross sections. This routine starts by asking for a new or existing .MXS file name. Then the centerline is specified by either by choosing a centerline file (.CL file) or selecting a polyline that represents the centerline. Next, the program prompts for the starting station of the centerline. If this is a new section alignment, the Make MXS File Settings dialog appears.

The Input-Edit Section Alignment dialog lists all the section stations and offsets in the alignment of an existing .MXS file.
Dialog if using an existing .MXS file

**Edit:** Allows you to edit the currently highlighted row.

**Add:** Allows you to add more sections by displaying the Make MXS File Settings dialog (shown below).

**Delete:** Deletes the currently highlighted row.

**Save:** Saves the MXS file, exits this dialog and draws the section alignment on the screen using temporary vectors (yellow for left offsets, magenta for right offsets). Any viewport change such as Redraw or Zoom will cause these vectors to disappear. The draw the section lines with Line entities, use the Draw Section Alignment command.

**SaveAs:** Saves a new MXS file with a user-specified name.

---

**Dialog used for a new section alignment**

**Station Interval:** Enter the station interval for sections.

**Right Offset:** Enter the width for the sections, right of the centerline. Not available if Pick Offset Distances is checked.

**Left Offset:** Enter the width for the sections, left of the centerline. Not available if Pick Offset Distances is checked.

**Type of Curve:** Specify either Roadway or Railroad curve to account for the differences in stationing curves.

**Prompt for Starting and Ending Stations:** This option allows you to specify the range of stations to process. Otherwise the program will use the full station range of the centerline.

**Pick Offset Distances:** Allows you to specify the offsets by using the distance between two picked points in the
drawing.

**Use Perimeter Polyline:** Allows you to specify a closed polyline that will be used as the limit of the cross sections. The offsets will be contained within this closed polyline.

**Stations at Interval:** Creates cross sections at the specified interval such as every 25 feet. If the Prompt for Starting and Ending Stations is on, then the program will apply the station interval to the user-specified range of stations. Otherwise the station interval is used along the entire centerline.

**Stations at Centerline Special Stations:** Creates cross sections at every transition point in the centerline such as the PC, PT, spiral points and end points.

**Stations at Profile PVC/PVT Stations:** Creates cross sections at profile vertical curve transitions stations. When active, the program will prompt for the profile to process.

**Stations at Profile High/Low Stations:** Creates cross sections at profile vertical curve high and/or low stations. When active, the program will prompt for the section file to process.

**Stations from Reference Section File:** Creates cross sections at stations contained in the reference section file. When active, the program will prompt for the section file to process.

**Stations at Crossing Polylines:** Allows you to select polylines that cross the centerline and creates cross sections at the intersections of these polylines with the centerline.

**Odd Stations with Specified Endpoints:** Creates cross sections at stations that are entered or at picked points along the centerline. This option also allows you to pick the left and right offset points which do not have to be perpendicular to the centerline.

**Additional Odd Stations:** Creates cross sections at the specified stations but the offsets are always perpendicular to the centerline with the user-defined default offset distances.

**Use Exclusion Areas:** This option prompts for selecting closed polylines to use as exclusion areas which are areas to skip for the section surface. The stations and offsets for the exclusion areas are stored in the section alignment file. Then routines like Calculate Section Volumes and Draw Sections will skip over these areas and not calculate volumes or draw section lines in these areas.

**Prompts**

- **Specify an MXS file dialog** Choose new or existing.
- **Polyline should have been drawn in direction of increasing stations.**
- **CL File/<Select polyline that represents centerline>:** pick centerline
- **Enter Beginning Station of Alignment <0.00>:** press Enter

**Pulldown Menu Location:** Sections

**Keyboard Command:** editmxs

**Prerequisite:** A polyline centerline or a centerline .CL file

**Draw Section Alignment**

This command will draw the location of the cross sections contained in an existing .MXS file. The cross sections stations can also be labeled Perpendicular or Parallel. The main purpose of this routine is to allow you to graphically view the location of the cross sections.
Sections from Surface Entities

This command allows you to create cross sections from a surface model. The stations for the sections, and the left and right offset distances, are defined in the MXS file. This file must be created before running this routine by using the Input-Edit Section Alignment command. The surface model is defined by lines or polylines with elevation. The polylines with elevation could be a contour drawing file from a photogrammetry firm, or it can be created from survey points with the Triangulate & Contour command. When using Triangulate & Contour it is useful to use the Draw Triangulation Lines option because the 3D triangulation lines represent all the breaklines in the surface which increases the accuracy of the cross section verses just using the contours. Breaklines or 3D polylines can also be used to represent ridges and valleys. The program samples the selected lines, polylines and 3DFace entities and calculates the intersections of these segments with any of the cross sections. The station, offset and elevation of these intersections make up the data in the section file. This section (.SCT) file can be reviewed or edited with the Input-Edit Section File command. Also, the section file can be plotted with the Draw Section File command or used in the by the Process Road Design command to calculate volumes.
Interpolate 0 Offset Elevation of Sections: When checked, this option will add a data point at offset zero for every station with an elevation that is interpolated from existing offsets.

Make Profile from 0 Offsets of Sections: Allows you to specify a .PRO file name to create from the 0 offsets of the sections.

Section End Point Treatment: The section end points are the left and right furthest offsets such as left and right 100 feet. When calculating sections based on the intersections with surface entities, there usually isn't an intersection exactly at the end points. For example, there could be contours at offsets right 87.31 and 105.43 but no intersection exactly at 100. There are four methods for determining the elevation for these end points.

Extrapolate Endpoint Elevation from Last Slope: This option calculates the slope from the last two offset-elevation points and calculates the elevation at the endpoint from this slope. For example, given offsets at 80 with elevation 100, and 90 with elevation 101, the elevation at offset 100 would be 102.

Extend at Flat Grade to Right and Left MXS Limit: This option uses the last offset elevation as the end point elevation. For example, if the last offset were 85 with elevation 102, the program would add an offset at 100 with elevation 102.

Cut-off at the End of Surface Data: This option does not add offsets at the end points. The sections will end at the last offset found in the surface model.

Interpolate from Surface Data Beyond MXS Limit: This option looks beyond the offset limit for more intersections with surface entities. The endpoint elevation is then interpolated between the offsets above and below the endpoint. For example, given offsets at 90 with elevation 101, and at 110 with elevation 103, the endpoint offset at 100 would have elevation 102. If this option is selected, the Distance to Add to MXS Limit for Interpolation field becomes available.

Distance to Add to MXS Limit for Interpolation: Enter distance.

Ignore Zero Elevation Lines in Surface Model: When checked, all zero elevations will be ignored.
Breakpoint Descriptions from Layer: When checked, this option will store the layer name of the surface entity as the description for the offset-elevation point in the section file.

Limit of Break Points Per Section: Specify the maximum number of break points per section. Default value can be set using the Section Defaults command.

Prompts

MXS File to Process Select the section alignment .MXS file
Section File to Write Specify the .SCT file
New or Append Choose whether to create a new .SCT section file, or add to an existing .SCT section file
Sections from Surface Model dialog Make selections
Select Lines, PLines, and/or 3DFaces that define the surface.
Select objects: Pick the surface entities

Pulldown Menu Location: Sections
Keyboard Command: sctsm
Prerequisite: Constructed surface model (.MXS file) to be sampled

Sections from Grid or Triangulation Surface

This command creates a cross section file (.SCT file) from a surface model that is defined by a 3D rectangular grid file (.GRD file) or a triangulation file (.FLT, .TIN). The grid file can be created in the Civil Design module with the Make 3D Grid File routine. The triangulation file can be created with the Write Triangulation File option in the Triangulate & Contour command. This command also requires a Section Alignment (.MXS) file to define the alignment and stations of the sections. The number of section points created is displayed at the end of the routine.

When using a triangulation file, there is an option for whether to link the sections to the triangulation. With the link, the section file will get updated in case the triangulation file is updated. When the link option is set to Auto, the update is done automatically. When the link option is set to Prompt, the program will prompt with a dialog for whether to update the sections when a triangulation change is detected.

Prompts

Choose Grid or Triangulation File to process choose existing .GRD, .FLT, or .TIN file
Choose MXS File to Process choose existing .MXS
Choose Section file to write enter new file name
Found 1410 section points.

Pulldown Menu Location: Sections
Keyboard Command: sctgrid
Prerequisite: Grid (.GRD) or triangulation (.FLT or .TIN) file, and a cross sections .MXS alignment file

Sections from Polylines

This command allows the user to select a polyline that represents a section in cross section view and writes it to a .SCT file. This can be useful for revising sections or for defining a new one. For example, let’s say you have extracted
sections from a surface model of the existing ground on a site, and have plotted them using the Draw Section File command. Next, the Polyline by Slope Ratio command is used to draw the proposed or final grade sections. Now use this command to send the sections to a Section file and compute the earthworks using the Calculate Sections Volume command. After selecting the command, the Polyline to Section File dialog appears.

The first time this command is selected, the output Section file is set to the same name as the current drawing. Select the Specify Section File Name button to specify a different name. The Station Interval edit box allows you to specify the amount that the default station number will be incremented as the station prompt shown below appears. The Interpolate Zero Offset toggle, if on, causes the program to output the elevation of the zero offset to the output .SCT file. A second and a third section file can be specified to process three sections at a time for each station. This allows you to handle both existing and final grades at once. The Prompt for Subgrades option will prompt for selecting subgrade polylines after the surface polyline for that section. After selecting the OK button, the prompts below appear.

Prompts

Exit/Pick text/ <Station <0.00>>: press Enter
Exit/Pick text/ <Starting elevation of grid <100.00>> 440 This supplies the drawing coordinate to translate the grid from.
[int on] Pick point at starting elevation and zero offset of section ([Enter] for none): press Enter
Select station 0.00 1st section polyline: select a polyline
Select station 0.00 2nd section polyline: select another polyline
Exit/Pick text/ <Station <0.00>>: E

Pulldown Menu Location: Sections
Keyboard Command: sctfpl
Prerequisite: Plot the section or profile to write to the .SCT file.
Sections from Points
This command creates an .SCT file from Carlson points in the drawing. An .MXS file is needed to define the centerline and the stations of the cross sections. The offsets for the cross section points are derived from the perpendicular distance between the centerline and the Carlson points. The cross section elevations come directly from the elevations of the points. In order to be included in a cross section, a Carlson point must be within the offset tolerance distance of the cross section line.

The order that the points within the Offset Tolerance at each station are used will of course determine the shape of the cross section, and in Civil 2010 there are now 3 ways for the collected points to be sorted. The Offsets Left to Right option sorts by the distance of each point from the CL. The Point Numbers option ignores that data, and instead sorts the points by their numbers. The Nearest Found option ignores both distance from the CL and point numbers and instead checks the horizontal and vertical proximity of the points to each other and sorts them based on this data. A powerful application of this method would be a survey of a tunnel where the points collected at each station were collected in a random order.

![Sections From Points dialog box](image)

Prompts

Choose MXS File to Process *select file*
Choose SCT file to Append/Write *select file*
Enter the maximum offset tolerance *<1.0>*: press Enter
Ignore Zero Elevations (*<Yes>/No*)? press Enter This option filters out all Carlson points that have a zero elevation.
Select points along the sections.
Select objects: *pick the Carlson points*
Sections from Coordinate File

This command will read a Carlson coordinate file, and, if the proper point descriptions are found, convert it to a .SCT file (stations, offsets, & elevations). This command offers great utility when combined with an electronic data collector. Sections can be surveyed and then compiled directly to cross sections, without having to extract them from a triangular mesh surface model. In other words, from the same file we can derive both plan and cross section views from one survey file. The .CRD file should have a point with a centerline description, followed by points that describe left and right offset points. For example, lets say we have a .CRD file with the following data in it.

Prompts

Coordinate File to Process dialog choose the .CRD file
Section File to Write choose the .SCT file to create
Sections From Coordinate File dialog put in range
Station Center Point Description <SC>: press Enter You can use any set of characters that you want to use as the zero offset description code, although SC is recommended because it is the default.
Station Left Point Description <SL>: press Enter You can use any set of characters that you want to use as the left offset description code, although SL is recommended because it is the default.
Station Right Point Description <SR>: press Enter You can use any set of characters that you want to use as the right offset description code, although SR is recommended because it is the default.

<table>
<thead>
<tr>
<th>Point#</th>
<th>North</th>
<th>East</th>
<th>Elevation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1000</td>
<td>1000</td>
<td>1050</td>
<td>CL/SC1+50</td>
</tr>
<tr>
<td>2</td>
<td>1007</td>
<td>1000</td>
<td>1049</td>
<td>EP/SL1+50</td>
</tr>
<tr>
<td>3</td>
<td>1008</td>
<td>1000</td>
<td>1048.2</td>
<td>ES/SL1+50</td>
</tr>
<tr>
<td>4</td>
<td>1010</td>
<td>1000</td>
<td>1048</td>
<td>TD/SL1+50</td>
</tr>
<tr>
<td>5</td>
<td>1012</td>
<td>1000</td>
<td>1046</td>
<td>BD/SL1+50</td>
</tr>
<tr>
<td>6</td>
<td>1014</td>
<td>1000</td>
<td>1047.6</td>
<td>TD/SL1+50</td>
</tr>
<tr>
<td>7</td>
<td>1016</td>
<td>1002</td>
<td>1047.8</td>
<td>PP</td>
</tr>
<tr>
<td>8</td>
<td>993</td>
<td>1000</td>
<td>1049</td>
<td>EP/SR1+50</td>
</tr>
<tr>
<td>9</td>
<td>992</td>
<td>1000</td>
<td>1048.2</td>
<td>ES/SR1+50</td>
</tr>
</tbody>
</table>
Notice that SC is the zero offset/centerline description code, SL is the offset left description, and SR is the offset right description. The station number should immediately follow and be the last characters in the description field. The station number may or may not contain a plus sign. This example would produce an .SCT file that contains the station number 150 and 10 offsets and elevations.

**Sections from Profile**

This command creates or adds data to a .SCT file from the station-elevation data in a profile file (.PRO). For every matching station in the profile and section file, the profile elevation is applied to a specified offset in the section file. For example, consider a profile for the edge of pavement that is a constant 12 to the right side of the centerline. The elevations from this profile could be added to offset 12 in the section file. The program will assign the elevation at station 1+00 from the profile to the elevation at station 1+00 and offset 12 in the section file. When creating a new section file, an .MXS file is needed to define the station interval.

**Prompts**

Section offset of profile <0.0>: enter the offset Negative for left, positive for right.
Choose SCT File to Append/Write dialog choose new or append existing .SCT file
Choose MXS file to process dialog choose existing
Choose Profile file to process dialog choose existing .PRO file
Created 11 section points.

**Sections from Layers**

This command creates cross sections from surface entities on one of the specified layers. The surface entities can be contours, triangular mesh, and other 3D drawing entities. This command is the same as Sections from Surface Entities with the addition of the layer filtering. Specify the layer names of the surface entities to include in the sections. For example, the layer names CTR and TMESH could be entered to use only the contour polylines and triangulation mesh on these layers. Entities on all other layers would be ignored. See Sections from Surface Entities for more details.

**Prompts**
Specify Layer Names Dialog

Pick Select Layers from Screen button, choose, then OK

MXS File to Process dialog

Choose existing .MXS alignment file

Section File to Write dialog

Specify a new .SCT section file to create or append existing

Sections from Surface Model dialog

Make selections

Select surface entities on corresponding layers.

Select objects: pick the linework to process

---

Prompts

Chapter 6. Civil Module
Select Symbol dialog
MXS File to Process Select an existing section alignment .MXS file
Section File to Write dialog
New or Append Choose between creating a new .SCT file or add to an existing section file
Select surface polylines.
Select objects: pick the polylines
Added 21 points to section file.
Writing section file > C:\scad2006\data\horn.sct

Pulldown Menu Location: Sections > Points on Section
Keyboard Command: sctpts2
Prerequisite: Surface polylines and an MXS file

Sections Points from Right of Way
This command is the same as Sections Points from Surface Entities except that the symbol for the right of way is automatically drawn as a downward pointing arrow. The description field for these section points identify them as right of way points. The description is POINT-ROW. A new .SCT file is created or an existing one appended to.

Prompts
MXS File to Process Select a section alignment file
Section File to Write dialog
New or Append Choose between creating a new .SCT file or add to an existing file.
Select right of way polylines.
Select objects: pick the polylines
Added 21 right of way points to section file.
Writing section file > C:\scad2006\data\horn.sct

Pulldown Menu Location: Sections > Points on Section
Keyboard Command: sctrow
Prerequisite: Right of way polylines and an MXS file

Sections Points from Pipes
This command is the same as Section Points from Surface Entities, except that the symbols for the pipes are automatically drawn as a circles with a radius set to the pipe width. The profile equivalent of this command is Profile from Pipe Polylines. When Draw Section File has vertical exaggeration, the pipe is drawn as an ellipse. The description field for these section points identify them as pipe points. The description is POINT-PIPE followed by the pipe size in feet (e.g. POINT-PIPE-1.500). The pipe polylines used to derive the pipe section points can be created with the Draw Pipe 3D Polyline and Assign Pipe Width to Pline commands in the Sections->Section Utilities menu. Also, the position of the pipe polylines on the pipe can be selected. The choices are Top, Center and Bottom.

Prompts
MXS File to Process Select a section alignment file
Section File to Write
New or Append Choose between creating a new .SCT file or add to an existing file.
Select pipe polylines.
Select objects: pick the polylines
Position of pipe polylines on pipe [Top/Center/<Bottom>]? Enter
Added 46 pipe points to section file.
Quick Section

This command creates section files in one step. The horizontal alignment for the sections can be defined by using picked points, a centerline file or a polyline. A section alignment (.MXS) file is not required for this routine. 3D screen entities or surface files (.GRD, .FLT, or .TIN) are used to define the vertical alignment.

There are two options under Quick Section Methods. The Station Series method creates sections perpendicular from the horizontal alignment at a station interval. In this case, the horizontal alignment represents the centerline. The Single Station method creates one section along the horizontal alignment and appends this section to the output section file. In this case, the horizontal alignment represents the alignment of the section.

For the Station Series method, there are settings for the Start Station of the horizontal alignment, the End Station to stop creating sections, the Interval for the stations, and the Left and Right Offsets to define the section width. There are also options to control the section stations to create. The Stations At Interval option will create sections at the specified station interval. The Stations At Centerline Points option will create sections at the special stations of the centerline for the centerline transitions such as PC, PT points.

For the Single Station method, the Station value is assigned to this section. The Zero Offset Point chooses between using the starting point of the horizontal alignment as the zero offset or selecting a point along the alignment as the zero offset.

With the Source Of Surface Model set to Surface Files, the program prompts for up to two surface files so that up to two section files can be generated at a time. When the Surface Model is set to Screen Entities, only one section file is created from the screen entities. With Screen Entities, there are a few more options. The Descriptions By Layer option will use the layers of the screen entities as the descriptions for the section points. The Interpolate From Data Beyond Section Limit will check for intersections with the section line and the screen entities beyond the left/right offsets to interpolate the elevations at the left/right offset extents. The Ignore Zero Elevations will filter out screen entities that are at zero elevation. The Interpolate Zero Offset Elevation Of Sections will create a section point at offset zero by interpolating between the nearest section points.

The program requires an output section file to store the results. There is an output option to draw the sections which calls the Draw Section File command. Finally, the option to Draw Plan View Polyline will draw the horizontal alignment as a polyline which is especially useful is the method to define the alignment by picked points was used.
Prompts

Pick starting point (CL-Centerline,P-Polyline): select a point
Pick second point: select second point
Pick next point (Enter to end): press Enter
Quick Section Options dialog
Choose Source of Surface Model, Screen Entities or Surface File, and make other selections. Click OK.

Keyboard Command: quicksect
Prerequisite: 3D Screen entities or surface files

Tablet Calibrate
This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Please refer to Configure, General Settings and Digitizer Puck Layout for selection of the correct puck layout before proceeding.

Tablet Calibration

Known Reference Points uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and press ok. The command line will prompt for the selection of each point from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the Tablet Calibration Dialog the next time it is accessed, so if you are working in the same drawing, you can use the Known Reference Points method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.
Drawing Scale with New Reference Points is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from your plan, this method can establish a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). Takeoff would compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be displayed on the Tablet Calibration Dialog next time when you calibrate the tablet, so you can digitize back to the previous coordinates using Known Reference Points method if you are working on the same drawing, though you might have moved or rotated your drawing on the digitize board option allows the user to specify the drawing scale of the plans be digitized and to assign an assumed northing and easting for a base point. When selected, Drawing Scale and Northing and Easting for Point 1 activate. Press ok. The command line will prompt for a pick of the first point.

Prompts
Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of
the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: pick a point
Pick second reference point: pick another point

Pulldown Menu Locations: Contour in Civil Design, Sections in Civil Design, Digitize in Takeoff
Keyboard Command: digsetup
Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your
computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in
Configure.

Digitize Sections Plan
This command allows you to digitize cross sections from a contour map. This is useful for pulling cross sections
and earthworks from existing contour maps made by aerial photography, USGS or other engineering firms.

Prompts

Use TABLET CALibrate command to set scale prior to using this routine.
Contour Increment <1>: 2 The contour increment/interval of the map to be digitized.
Pick Zero Offset Station point: pick a point
Zero Offset Elevation: 1122.56
Starting Contour elevation <1122>: 1124 This is the elevation of the first contour to digitize.
Next Point Up Right: pick a point

If the first contour line is moving up in elevation and to the right of the zero offset point, then pick a point on the
first line with elevation 1124. If this is not the case, then review the options below to change the prompt mode.

Press digitizer/mouse buttons:
1 - To pick next point on contour line
2 - To change to UP mode
3 - To change to DOWN mode
4 - Prompt for new elevation (this elevation is applied to the next point picked)
5 - To change to RIGHT mode
6 - To change to LEFT mode

or Press Keys:
[X] - To end point prompting
[U] - To change to UP mode
[D] - To change to DOWN mode
[N] - Prompt for new elevation (this elevation is applied to the next point picked)
[E] - Erase/Delete the last point picked
[R] or [+]- To change to RIGHT mode
[L] or [-] - To change to LEFT mode

Press one of the keys, buttons or select from the side bar screen menu to change prompt to appropriate mode. When
you have finished picking points press the [X] key to end the point prompting. The program then prompts:
Send Section to a file (Y/N) <Y>: press Enter
Name of Section File to write <sc/data/example.sct>: press Enter If the file already exists the user is asked to
Overwrite or Append to the file.
Section Station Number: 100 The station, offsets and elevations are then written to the section (.SCT) file.
Digitize Sections XSec

This command creates a section file (.sct) by digitizing a section drawing. The command starts with the dialog shown below where you specify the section file name to create. The station interval is used to automatically default to the next station value when digitizing a series of stations. The Interpolate Zero Offset option will interpolate an elevation at the exact zero offset.

After the dialog, the program will prompt to pick three reference points on the section. These points should have known offsets and elevations. Additional sections can be aligned by a single point. Corners on the section grid can be used for these reference points. The reference points and the user-entered offset and elevations for them sets up the program for the section. Now you can start picking the section grade points.

You can also digitize existing and final surfaces back to back, and there is an undo function that will allow undo while digitizing points. As the section is digitized, it is shown in a real-time graphics window. Holding down the right mouse button acts as a zoom function, while holding down the mouse scroll button acts as a pan. The puck keys can be used to enter all the input data.

Prompts

Digitize Section dialog

Calibrate section sheet:
Pick First section sheet reference point: pick a point on the section grid
Enter offset <0.0>: -50
Enter elevation: 200
Pick Second section reference point: pick another point on the section grid
Pick Third section reference point:

Enter offset: 50
Enter elevation: 210

Section station to digitize <0.000> : 133.63
Digitize break point for SAMPLE GRID section 133.630 (Enter to end): pick a point on the section starting at the left and working right

Save changes to SAMPLE GRID section 133.630 [ <Yes>/No]? press Enter

Digitize another station [ <Yes>/No]? N

Calibrate next section:

Pick section reference point: pick a point on the section grid

Enter offset < -50.00 > : 0
Enter elevation < 200.00 > : 200

Save changes to SAMPLE GRID FINAL section 133.630 [ <Yes>/No]? press Enter

Digitize another station [ <Yes>/No]? N

Pulldown Menu Location: Sections > Digitize Sections

Keyboard Command: digxsec

Prerequisite: Affix cross section on digitizing tablet
Digitize End Areas

This command writes an earthwork (.EW) file that can be used by the Print Earthwork File Report command and print an earthworks and volumes report. It is the users responsibility to record the sections in the proper consecutive sequence. The earthwork (.EW) file written by this command can be edited in any ASCII text editor.

Prompts

Datum elevation <0.0>: 100 Enter the datum elevation that you calibrated the tablet with.
Horizontal Scale <20.0>: press Enter
Vertical Scale <20.0>: 10

Digitize cut area (Enter to end): pick a point Starting at either end of the section, digitize break points of cut area.
Digitize cut area (Enter to end): pick a point
Digitize cut area (Enter to end): pick a point .......
Digitize cut area (Enter to end): press Enter Press Enter to end prompting of break points. The end area is then displayed.

More cut areas (Y/N) <N>: [Enter] Respond with Y if you have more cut areas.

Digitize fill area (Enter to end): pick a point
Digitize fill area (Enter to end): pick a point .......
Digitize fill area (Enter to end): pick a point Press Enter to end prompting of break points.

More fill areas (Y/N) <N>: press Enter Respond with Y if you have more fill areas.

Send data to file (Yes No) <Y>: press Enter If you made no errors respond with Y to save data in the file.

End Area File to write <c:\scad2006\data\quan.ew>: press Enter
Station Number: 150 This would enter a station of 1+50.

Pulldown Menu Location: Sections > Digitize Sections
Keyboard Command: digendar
Prerequisite: An existing cross section on digitizing tablet. If digitizing a map on your tablet use the Tablet Calibrate command to calibrate your digitizer tablet to the scale of the drawing.

Section Conversions

All Import commands in this submenu are designed to convert other section file formats to the Carlson section (.SCT) file format. The Import Columnar Text has some options to make the program match the import data. This routine can be used for section text files that have station, offset, elevation and optionally description separated by spaces or commas. All the other Import routines read specific formats from other software. The Export commands are designed to convert the Carlson section (.SCT) file format to other section file formats. You will be prompted to specify the file name to convert, then specify a section (.SCT) file name.

Note: The Import/Export LandXML Files routine in the File menu supports section data as well as other survey and civil data types.

Another Note: The Section Report routine can be used to Export section data from Carlson and this command includes an option to use the Report Formatter which allows you to select the fields to export and their order. Plus the Section Report report formatter has functions to export to Excel and databases.

Prompts

Prompts and commands vary for importing and exporting section file data.

Importing:
Import Columnar Text
Type of delimiter [<Space>/Comma]? C for comma. Choose the type of separator between fields in the import file.

Section data contains description field [Yes/<No>]? N for no. This option specifies whether the import file contains descriptions for the section points.

Add description to section data [Yes/<No>]? Y for yes. This option will assign a specified description to the section points.

Description for section data: TOPO

Import Agtek Reads .ROG and .RDS format section files (ASCII only).
Import Arkansas DOT Imports Level Note File
Import C&G Reads C&G .CEW section files.
Import CAICE Earthworks Reads .ERP files.
Import Ceil Reads CEAL section files.
Import EMXS Reads section data from .XNG files.
Import GEOPAK Reads .XRS, .XSR, and .TXT format section files (ASCII only).
Import Georgia DOT Reads .END files.
Import IGRDS Reads .LIS, .RDS, and .TXT files.
Import InRoads Reads .TXT files.
Import MicroStation Reads InRoads .GEN files.
Import Moss Reads MOSS section files.
Import NC DOT Reads .ORI and .TXT files.
Import Pizer Reads .TXT files.
Import RoadCalc Reads RoadCalc (Eagle Point) sections files.
Import SMI Reads .CUT format section files (ASCII only).
Import Softdesk Reads .SEC format section files (ASCII only).
Import Spanish SC1 Reads ISPOL .SC1 section files.
Import Spanish TRV Reads CLIP .TRV section files.
Import TDS Reads .RD5 and .TP5 files.
Import Terramodel Reads .XSC files.

Exporting:
Export C&G Converts Carlson .SCT file to .CEW format.
Export GEOPAK Converts Carlson .SCT files to .TXT format.
Export IGRDS Converts Carlson .SCT files to .RDS format. Prompts for section surface type - original ground or final surface.
Export RoadCalc Converts Carlson .SCT files to RoadCalc (Eagle Point) format.
Export Topcon Converts Carlson .SCT files to .RD3 format.

Pulldown Menu Location: Sections > Section Conversion

Keyboard Commands: xsecread, agtek, level, ceg, geopak2sct, gadot2sct, igdrs2sct, moss, ncdot2sct, pizer2sct, inroadcalc, smisct, softsct, sc1_to_sct, trv_to_sct, tm2sct, sct2geopak, sct2igrds, outroadcalc, gen2sct

Prerequisite: Sections files; formats vary by command

---

Input-Edit Rock Section File

This command allows the user to edit rock section stations from a Stations List and then save the .SCT file. Stations should be selected one at a time from the ordered list. These edits may include offset and depth values to the left and to the right. The rock section files may be edited, deleted or cleared as needed, but only an existing station from the list may be edited. To start, an existing section file must be read, then an existing rock section file needs to be chosen or a new one created.
Prompts

Existing Section File to Read dialog select SCT file
Rock Section File to Write dialog: select SCT or create new SCT file
Input-Edit Rock Sections dialog select Edit and make changes as needed
Input/Edit Rock Offsets & Depths enter values
Save changes.
Last station to average <1614.160>: press Enter
Section File to Write select a SCT file name and folder
**Pulldown Menu Location:** Sections > Rock Sections

**Keyboard Command:** setrock

**Prerequisite:** .SCT file

---

### Create Overshoot Section File

This command allows the user to create an overshoot section file using an existing .SCT section file and an existing rock section file. The existing .SCT file must be read, then an existing rock section file (.SCT) needs to be chosen. The new overshoot section file and file name will then be written. An overshoot drop depth is the key prompt in this command, along with the values for the beginning and the final stations. This will begin the processing of this routine and create the new data.

**Prompts**

- **Existing Section File to Read** select SCT file
- **Rock Section File to Read** select SCT file
- **Section File to Write** enter new SCT file name
- Enter the overshoot drop depth: 5
- Range of stations: 0.00 to 150.00
- Enter beginning station to process <0.00>: 
- Enter final station to process <150.00>: 1000
- Last station to average <1614.160>: press Enter

### Draw Section Template DWG

This command is step one in the Point on Section procedure. It inserts a section or template drawing to scale on a standard section sheet. The section or template must be an existing, separate drawing (.DWG) file. Prior to running this command, the scale and text size should be set with the **Drawing Setup** command found on the Settings menu.

**Prompts**

- **Enter the horizontal scale** <1.0>: press Enter
- **Enter the vertical scale** <1.0>: press Enter
- Three file selection dialogs follow.

---

**Choose Standard Section Sheet:** pick existing .DWG file The standard section sheet is a drawing created at 1'=1'
Choose Profile File: pick existing .PRO file. The profile (.PRO) file for the vertical alignment defines the insertion elevation for the template insertion point.

Choose Tunnel Template: pick existing .DWG file. The tunnel or section template is a drawing created at 1’=1’ with the insertion point for the template at coordinates 0,0.

Enter profile station for section/template: 117060
Enter or pick section/template insertion point pick a point or press Enter for none

The standard section sheet with template in the center of sheet at the input horizontal and vertical scales is plotted.

**Pulldown Menu Location:** Sections > Points On Section

**Keyboard Command:** tunnel

**Prerequisite:** Vertical alignment in .PRO file, template or section drawings, and section sheet drawing.

---

### Point Placement on Section

This command is step two in the Points on Section procedure. Before running this routine, the section or template sheet must be drawn on screen and there must be an existing coordinate (.CRD) file to read, with station and offset data in the description fields, as described under Points on Section. Station location points may also be picked on screen with the Points option. This command draws points on the section template from the coordinate (.CRD) file or via the Points method. If the Point option is selected, a Section Settings dialog appears, followed by a Snap Point dialog. The point elevation and the offset data in the description field are used to locate the point on the section.

**Prompts**

Place points from .CRD file or pick points [File/<Points>]? F
Enter the horizontal scale <1.0>: press Enter
Enter the vertical scale <1.0>: press Enter
Layer for points <PNTS>: press Enter
Select Coordinate File to Read Dialog pick a file You select the crd file to process.
Range of Point Numbers to use (A for All) <A>: press Enter for all points to process
Wildcard match of point description <*>: press Enter for all points with or without descriptions
Plot Full or Abbreviated text (Full/<Abbrev>)? F Here we used F for full description.
Range of stations: 117060.000 to 117090.000
Enter station to process: 117060
Enter search zone <1.0>: Search zone applies to survey data collected in an approximate range plus or minus a small distance on a known station.
Pick Center of Grid [int on]:
Pick a known elevation on the centerline and on the next prompt enter that elevation.
Enter base elevation of grid: 278
Enter station to process: Enter next station or press Enter to end
The points plot on the template or cross-section.

Point option dialog

Points plotted on template or cross-section

Pulldown Menu Location: Sections > Points On Section
Keyboard Command: ptsct
Prerequisite: Drawn section sheet and .CRD file with station and offset description field data
**Point Offset Report/Plot**

This command, which is step 3 in the Points on Section procedure, labels the tight/clear distances between points and a polyline on the section. Tight points are inside or to the right of the polyline while clear points are outside or to the left of the polyline. The polyline should be drawn in a clockwise direction. The points can be picked on the section or located from a .CRD file with the station and offset data in the description fields as described under Points on Section.

**Prompts**

Enter the horizontal scale <1.0>: press Enter

Enter the vertical scale <1.0>: press Enter

Coordinate File to Process Dialog Box pick a file Select the coordinate file for clear/tight report.

Write report to file (Yes/<No>): Y

Enter the report file name to write: 117060.XS

Write report to printer (Yes/<No>): Y Make sure the printer is on-line and connected to the printer port.

Press Enter to continue press Enter

Write report into drawing (Yes/<No>): Y

Enter the report title <Tight/Clear Report>: press Enter

Pick location for report: pick starting location for Tight/Clear report

Use manual or automatic label placement (Manual/<Automatic>): press Enter Automatic draws the arrow leader lines perpendicular a set distance prompted next. Manual allows picking each leader lines location.

Label offset distance <1.00>: press Enter

Enter station to process: 117060

Enter search zone <1.0>: Search zone applies to survey data collected in an approximate range plus or minus a small distance for a known station.

Pick Center of Grid [int on]: Pick a known elevation on the centerline and on the next prompt enter that elevation.

Enter base elevation of grid: 278

Select polyline: pick template polyline

Number/<Pick Point>: N You can pick offsets or use point numbers.

Pick point/<point number or range>: 8-13

<table>
<thead>
<tr>
<th>Station</th>
<th>Offset</th>
<th>Elev</th>
<th>Pt#</th>
<th>North</th>
<th>East</th>
<th>TIGHT CLEAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>1170+60.00</td>
<td>L9.20</td>
<td>282.38</td>
<td>8</td>
<td>443246.7039</td>
<td>785285.7725</td>
<td>+0.11</td>
</tr>
<tr>
<td>1170+60.00</td>
<td>L9.15</td>
<td>271.98</td>
<td>9</td>
<td>443246.7118</td>
<td>785285.7231</td>
<td>+0.57</td>
</tr>
<tr>
<td>1170+60.00</td>
<td>L1.10</td>
<td>289.28</td>
<td>10</td>
<td>443247.9877</td>
<td>785277.7749</td>
<td>-0.04</td>
</tr>
<tr>
<td>1170+60.00</td>
<td>R4.30</td>
<td>288.13</td>
<td>11</td>
<td>443248.8436</td>
<td>785272.4431</td>
<td>-0.19</td>
</tr>
<tr>
<td>1170+60.00</td>
<td>R9.00</td>
<td>281.18</td>
<td>12</td>
<td>443249.5886</td>
<td>785267.8025</td>
<td>-0.32</td>
</tr>
<tr>
<td>1170+60.00</td>
<td>R9.30</td>
<td>272.48</td>
<td>13</td>
<td>443249.6361</td>
<td>785267.5063</td>
<td>+0.66</td>
</tr>
</tbody>
</table>

Pick point/<point number or range>: press Enter

Enter more point numbers or pick more offsets or press return for no more.

Enter station to process (Enter to End): Enter next station or press Enter to end.

With Point Offset Report/Plot completed the finished product with points plotted on the cross section can be plotted to a printer or plotter with Tight/Clear or Cut/Fill report included as shown.
**Pulldown Menu Location:** Sections > Points on Section  
**Keyboard Command:** sc offset  
**Prerequisite:** Drawn section sheet

## Input-Edit Section File

This program can be used to enter or edit data stored in a section file (.SCT file), including a real-time graphic window in the Edit mode. The section data consists of stations, offsets, elevations and descriptions. This command also has utilities for translating the offsets and elevations, deleting stations from the file, intersecting the out slopes of one section file with another, combining multiple occurrences of the same station and sorting the stations, offsets and elevations.

While editing the section file, a second section file can be used as reference. To choose this file, pick the 2nd button. For example, when editing the proposed section file, you can reference and view the ground section file as the second file. Besides showing the reference section in the graphic preview, the program also reports the end areas while editing a section station. Also, the reference section can be used to tie to the catch point.

The program begins by prompting for a New or Existing section .SCT file to process. The Section file to process dialog appears, allowing you to specify the file that you want to operate on. Use the New option to create a new file. Use the Existing option to edit the offsets and elevations for station/sections that you have already created, or append new stations to a file. The program defaults to a section file with the same name as the drawing or a name that you specified using another section command. You also can choose a 2nd existing .SCT file to reference. After specifying the file name(s), the program displays any stations currently in the file, in the Stations List of the Input-Edit Section File dialog box.

Alternately, when sections are drawn in the drawing, you can double-click on a section polyline to launch Input-Edit Section File for the .SCT file associated with the section polyline.

If you specified a new file, the Stations List box will be blank. To edit and display the offset and elevation data at a station, you can double click on the station in the Stations List box, or input the station in the Station to Edit edit box at the bottom of the dialog. To add a station to a new file or existing file, you must enter the station in the Station to Edit edit box. Stations will present in accordance with the Section-Profile settings in Configure under the Settings pulldown menu (eg. 10+00, 1+000, 1000).
**Edit:** Opens the Edit Station dialog which shows a graphic of the section on top, a list of the offset-elevation points in the middle, and the function buttons on the bottom. To add an offset point, type in the offset, elevation and optional description in the spreadsheet. Left offsets are entered as negative numbers. You can enter the slope or ratio from the last point and the program will calculate the elevation. To edit an offset point, highlight the point from the list and then edit the values in the Offset, Elev and Desc columns. The highlighted point will be marked by an X in the graphic screen. The Sort button will sort the list of offsets from lowest to highest, left to right. It is recommended that you Sort offsets before doing the Tie command, so that the left-most and right-most offsets appear first and last in the offset list. The Up button will move the highlighted offset point up in the list. Likewise the Down button moves the highlighted offset point down in the list. Prev (F2) and Next (F3) buttons move through the stations and allow you to review and edit stations in forward or reverse order. The scroll bar can also be used to quickly move through stations and then zero in with Prev (F2) or Next (F3).
The Add Row button inserts an offset line above the currently highlighted row. The Remove Row button erases the highlighted offset and elevation from the list. After inputting or editing press the OK button to return to the Stations List dialog and keep any changes you have made. Select the Cancel button if you want to cancel changes made to the current station. Extend Pavement/Subgrade will allow you move a surface point and shift, in parallel, the associated subgrades and tie points. One application, shown below, is to extend a shoulder point and re-compute the TIE point, all in one clean operation:

Another application of Extend Pavement/Subgrade is to move the curb position and all associated subgrades. The "inside" curb point is at 12.00 units from centerline. If the pavement is extended from 12 to 15 at this station, use of this feature will extend the subgrades, maintain all slopes and re-compute the TIE point, as shown below:
A real-time report of offset-elevation-slope now displays in the top of the graphic as you move the cursor across the section in the graphic window. The screen defaults to zoom mode where holding down the right-mouse button zooms in and out. You can also switch to pan mode. There are buttons for zoom extents, zoom in and zoom out. If your mouse has a scroll button, you can hold it down to pan and scroll it to zoom in and out. You can also set the Vertical Exaggeration ranging from 1X to 10X and including “Fit”. Show subgrades has the ability to tie a subgrade into the surface. Grid Ticks Only just shows the left and bottom axis lines of the grid with grid tick marks along the axes. With Auto Zoom All turned off, you can hold the same view position as you click Next and Previous and move through the list of stations. The Check Offset field calculates an elevation based on an entered offset.

**Drive (Edit Station):** This function scrolls through the sections at the rate of speed specified by the user in the Speed window. The Drive View options determine whether the sections are displayed using the full width of the graphic window or centered in the window. The combination of Full Grid Range and Auto Zoom All allows the sections to rise and fall with the centerline elevations, as if you were driving an actual road. With Auto Zoom All off, and Full Grid Range on, the grid itself moves up and down at the current position of the first section, as you drive. Focus View On Offset Range allows the user to set the left and right viewing limits of the sections. Section data beyond the specified limits is not displayed.

**Elevation Field (Edit Station):** Equations (+, -, *, /) can be entered to calculate or adjust an elevation. For instance, to subtract 1.25' from elevation 1926.18, simply enter 1926.18-1.25 and press enter. The new elevation will be
calculated and displayed in the viewer window.

**Tie (Edit Station):** The Tie button allows you to tie the left and right surface points of the 1st section file into the 2nd section file. It is used for classic outslope intersects from final grade to existing grade. The dialog layout includes an option to tie the section to a specified elevation, in addition to a surface (second section file). A left or right tie direction can also be selected. If a point has been tied in from SH for shoulder at offset -20 at 3:1, a new offset with the description "TIE" is created. If you try another outslope such as 4:1 from the same SH shoulder point, a new "TIE" point is created and the old TIE point is removed automatically.

![Tie Offset dialog](image)

**Lock:** This function will tag the section file as locked so that no routine can automatically overwrite this file. If a routine attempts to overwrite this section file, the program will stop, report that the file is locked and prompt whether to override the lock.

**Translate:** Allows you to add or subtract a distance from the offsets to adjust or shift the centerline. You can also adjust the elevations up or down. When using this option, you can choose the range of stations to operate on (starting and ending stations) and the values to adjust the offsets and elevations. If, for example, you want to shift the centerline, but not the elevations, enter the plus or minus amount you want to translate, and when prompted for the elevation enter zero.

![Translate Sections dialog](image)

**Scale:** Allows you to scale the station, offsets and/or elevations by the specified scale factor. This function can be used to convert between English and metric units.
Delete: Allows you to remove a station or range of stations from the Stations List. You can delete a range of stations or an individual station. Also there are options to delete all the data for the selected stations or filter to delete only data that is outside an offset or elevation range. Since the station editor data is stored in memory, if you accidentally delete a range, Quit the editor without saving the stations to disk. Then recall the original file.

Reduce: Allows you to remove offsets from a range of stations by removing vertices in the offsets that are virtually in a straight line. Using an offset cutoff, meaning no offset and elevation moves more than the entered amount (eg. 0.01), excessive numbers of vertices can be eliminated. The command is similar to Reduce Vertices when applied to the plan view.

Sort: Allows you to sort the station numbers into ascending order, and sort the offsets and elevations in the individual station records (offsets are sorted from left to right). When sections are derived from the Sections from Surface Entities command they are already sorted, but when sections are digitized or input manually they occur in the order that you digitized them. So, for proper plotting and earthworks, you may want to run the Sort option before processing.
**Combine Stations:** Used to bring together in one record slot multiple occurrences of the same station number. This can occur when using the Digitize Sections (XSec) command and the section that you are digitizing has match/break lines which forces you to digitize the station in two or more parts.

**Interpolate:** Allows you to add or overwrite a station between two stations or projecting forward from two stations. You can choose to interpolate a single station or an interval of stations. Specify the two known stations in the Start Station and End Station edit boxes, as well as the interval if using the interval method. The program will do straight line, mathematical interpolations, adding offsets to the interpolated stations to match the totality of offsets in the starting and ending stations. However, if the offsets have descriptions, you can choose to interpolate by description and the program will interpolate by description (eg. EP at 12 on Station 1100 and EP at 15 at station 1150 would lead to EP at 12.6 at 1110). There is also an option to reference a profile, so if station 1100 and 1150 were on either side of a high point at 1125, the interpolated offsets would respect the profile as well as the starting and ending station. Use of this command is often critical to creating accurate digital terrain models of sites for machine control. Select the OK button to execute the function with the current settings or select the Cancel button to abort the process.

**Copy Station:** Allows you to copy a station that already exists to a new or existing station number. Choose the existing From Station using the edit pulldown box, then enter the new station number in the To Station edit box. Select the OK button to execute the function with the current settings, or select the Cancel button to abort the process.

**Rename Station:** Allows you to change the value of a station. In the dialog, select the existing station from the list and enter in the new station value.
**Tie Station:** Allows you to tie the outslopes into the reference second section file. This routine first brings up a dialog to specify the range of stations to process. It includes a line to set the slope to tie with. The program will start from the left most offset and use this slope to find the intersection with the reference section file. Then the intersection from the right most offset is calculated with this slope. These intersection points are the tie points. The slope can be defined by percent, ratio, continue the last slope, and vertical.

![Tie Station Dialog](image)

**Add Subgrades:** Adds subgrades to the sections with specified depths and offsets. You can add multiple subgrades at a time by filling in the spreadsheet. Each row of the spreadsheet is for a separate subgrade. Each subgrade definition takes a description, left and right offsets, depth and intersection method of either straight up or at a specified slope. The subgrades are added by referencing the existing surface elevation and dropping down the specified depth. The center of the subgrade always drops down vertically. The outside of the subgrade ties in by the specified intersection method. The station range to add the subgrades can be the same of all the subgrades or specified separately for each subgrade.

![Add Subgrades Dialog](image)

**Save:** Saves the currently loaded section file.
**SaveAs:** Allows you to save the currently loaded section file as a different file.
**Exit:** Allows you to exit from the section editor and return to the drawing editor. The program will warn you to save to a file if you have made changes.

**Pulldown Menu Location:** Sections  
**Keyboard Command:** scted  
**Prerequisite:** None

**Draw Section File**
This command generates plots of cross-section data which can be used to further iterate the corridor design or used for construction documentation. The Section files drawn with this command can be created by several methods.
including the Input-Edit Section File, Digitize Sections, any commands under the Create Sections from... menu, Process Road Design or Road Network commands.

For metric-based projects, please refer to the Drawing Metric Section Sheets section of this document.

The Draw Section File routine will call two primary dialog boxes:

- The first is the Section Files for Drawing dialog box that allows you to specify the Section files (.sct) to be drawn and some general sheet and layer settings.
- The second is the Draw Section File dialog box that allows you to specify various scale, layout and labeling settings.

If the Type of Plot option in the Draw Section File dialog box is set to "Sheet," a third Section File Sheet Drafting Parameters dialog will be displayed which provides detailed sheet layout settings.

![Section Files for Drawing dialog box](image)

**Files:** Specify up to six Section (.sct) files to plot and Select a layer for each. To remove a section file entry from the dialog box, click the appropriate 1st, 2nd, 3rd, etc, button which displays the standard File Selector dialog box. Without selecting a file, click the Cancel button from the File Selector dialog box to remove the previously specified file.

**Layers:** Key-in a desired layer name for each section file or click the Select button to specify a previously established layer.

Key-in a desired layer name or click the Select button to specify a previously established layer for each of the cross-section sheet items:

- Grid Text
- Main Index Grid Lines
- Intermediate Grid Lines
- Subgrade

**Prefix Layer Names with Section Name:** Enable this option if the layer for each section name is to be prefixed with the Section file name.

**Style:** Key-in a desired text style or click the Select button to specify a previously established text style that will be assign to all labels.

**Crossing Pipe Label Setup:** This button opens the Crossing Pipe Label Setup dialog box that allows you to establish settings for drawing and labeling pipes that run along or intersect the cross section alignment.
**Load Settings:** This option allows you to load the content of a previously saved Section Settings (.sst) file.

**Colors:** This option allows you assign colors to each of the aforementioned items. The recommended color for each item is *ByLayer*.

**Linetypes:** This option allows you assign linetypes to each of the aforementioned items and line widths to each of the section files. The recommended linetype for each item is *ByLayer*.

**Crossing Pipe Label Setup**

**Pipe Symbol:** Choose whether to show the Pipe Crossing symbol as a circle or a square.

**Text Style, Text Scaler and Decimals:** Specify the text style, size and precision of Pipe Crossing labels.

**Label Offset, Label Elevation, Label Pipe Size, Label Pipe Name:** Enable any or all of these options to label the distance left or right off the alignment (Label Offset), the invert elevation, pipe size and pipe name of each crossing pipe. Use the optional settings for specifying "Prefix" or "Suffix" text for each label.

**Draw Pipe Crossings on-the-fly:** Enable this option to have Crossing Pipes that have been created using a Sewer Network file (.sew) or Draw Pipe 3D Polyline command drawn in cross sections. It is not necessary to enable this option if Pipe Crossings have been saved to a Section file (.sct) using the Section Points from Pipes command.

**Alignment:** Pick this button to select either a Centerline file (.cl) or Section Alignment file (.mxs) to scan for Crossing Pipes.

**Layer and Color:** These settings specify the layer and color of the Pipe Crossing symbol.

After specifying the Section Files (.sct) to be drawn and applying settings for each, the Draw Section File dialog box opens:
**Horizontal Scale:** Specify the horizontal scale.

**Vertical Scale:** Specify the vertical scale. The vertical scale relative to the horizontal scale determines the vertical exaggeration factor.

**Link Sections to Files:** This setting controls the linkage of the plotted sections to the actual section (.sct) file(s), determining how changes to the file affect the plotted sections.

- **Off:** A linkage between the SCT file and the graphical section entities is not formed; you will need to manually re-create section sheets after section design changes.
- **Prompt:** You will be asked whether or not to update the plotted sections when the underlying SCT file is changed.
- **Auto:** The plotted sections will automatically update when the underlying SCT file changes.

**Type of Plot:** Specify how the sections will be plotted:

- **Vertical Stack** - will place the sections into a column up to the value of Maximum Sections per Column before beginning a new column.
- **Pick Location** - provides information about the section at each station and prompts you to precisely place each section to a location of your choosing.
- **Sheets** - will plot the sections on a block section sheet suitable for plotting.

**Fit Each Vertical Grid:** When checked, the grid bottom elevation and grid height are set automatically and you may specify values to add to the top and bottom of each grid (see Vertical Grid Adder to Top and Vertical Grid Adder to Bottom). When not checked, you specify the elevation of the grid bottom and the grid height through the Grid Bottom Elevation and Grid Vertical Height controls, respectively.

**Output to Separate Drawing:** When checked, this option will prompt for a New drawing name and location into which all cross sections will be drawn.

**Draw Reverse Order:** When checked, this option will draw the cross sections in the order of the highest numbered station to the lowest.

**Scan File to Set Defaults:** This button allows the program to set the minimum and maximum parameters. If you choose this option, the program will automatically set the range of stations, vertical spacing distance, right and left
grid distances and starting/datum elevation. This option writes a file called "sectsort.tmp" that is read and used to set the defaults the next time you use the program. Therefore, if you are selecting a different .SCT file to plot you should use this option to update the .TMP file.

**Range of Stations to Draw:** Specify the range of stations from the file which will be drawn.

**Interval of Stations to Draw:** Specify the interval of stations to draw. For example, perhaps you sampled every 25 feet with the Sections from Surface Model command for more accurate quantities but only want to plot 50 foot stations. ALL is the default value for this field.

**Vertical Grid Adder to Top:** Specify the distance that will be added to the highest elevation of the section for the sheets and pick location options. This option is only available when Fit Each Vertical Grid is checked ON.

**Vertical Grid Adder to Bottom:** Specify the distance that will be subtracted from the lowest elevation of the section for the sheets and pick location options. This option is only available when Fit Each Vertical Grid is checked ON.

**Grid Bottom Elevation:** Specify actual bottom elevation for each section grid. This option is only available when Fit Each Vertical Grid is checked OFF.

**Vertical Grid Height:** Specify actual grid height for each section grid. This option is only available when Fit Each Vertical Grid is checked OFF.

**Vertical Space Between Grids:** Specify the distance the sections are stacked above the last one plotted when the Vertical Stack option is specified.

**Maximum Sections Per Column:** Sets the maximum number of sections allowed per column when the Vertical Stack option is specified.

**Label Reference Offsets:** When enabled, the offset from selected break points of one section file relative to the position(s) of selected points from another section file can be labeled onto the plots.

**Label Right of Way:** When enabled, this option will label Right of Way points as defined using the Section Points from Right of Way command. Press the Set button to the right of this toggle to set the text size and label offset scalers, layer and text style settings.
**Draw Vertical Line:** Places a vertical line, from top to bottom, through the Right-of-Way point.

**Draw Leader/Draw Arrow Symbol:** When enabled, a short vertical line is drawn, with or without, the arrowhead through the Right-of-Way point.

**Label Position:** Indicate the desired orientation of the "ROW" text label.

**Label Elevation at Zero Offset:** Will label the section elevation at offset zero. The label is drawn on the section grid just above the section line. Press the Set button to the right of this toggle to set the display precision, text size scaler, prefix, suffix, color and layer for these labels. The Draw Leader option can be set to None, Diagonal or Vertical.

**Label Break Pt Offsets:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.
Label Break Pt Elevations: Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.

Label Break Pt Descriptions: Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the text size scaler, layer, and description match for these labels.

Label Slopes: Will label cross-slope values of the Section. Press the Set button to the right of this toggle to set
the text and symbol size scaler, layer, and label format for these labels. Enable the **Label Relative to Zero Offset** option to ensure slopes are measured from the zero offset line out to the extents of the Section. Also, if you do not want all slopes on the Section labeled, you can use the “Label From” and “to” settings to specify Section point descriptions to label between. For instance, you could specify to only label the slope between the SW (sidewalk) and SH (shoulder) ID points as defined in the Template file (.tpl) that was used to generate your Section file (.sct).

**Label End Areas:** Will label cut and fill end areas on each section. Or, if the **Use Table** option is enabled, cut and fill end areas will be placed in a table.

**Hatch End Areas:** This option hatches the cut/fill areas between the first and section section files. The program treats the first section as existing and the second as design for determining cut verses fill. There are separate hatch pattern, color and scale settings for cut and fill.
**Draw Break Pt Leader:** Enable this option to include a leader with the Label Break Pt Offsets, Label Break Pt Elevations or Label Break Pt Descriptions options. Click the Set button to specify the desired layer for the leader.

**Note:**

- When redrawing sections, the program retains any custom edits to label and leader positions.

**Draw Break Pt Symbol:** Enable this option to include a symbol with the Label Break Pt Offsets, Label Break Pt Elevations or Label Break Pt Descriptions options. Click the Set button (to the immediate right of the Layer control) to specify the desired layer for the symbol. Click the Set button (to the immediate right of the Symbol control) to specify the desired symbol and indicated the desired Size Scalar.

**Break Pt Label Offset:** Indicate the desired offset amount from the surface break point to its label.

**Plot Grid:** Uncheck this toggle if you do not want the grid to plot.

**Text Only:** Check this toggle if you only want to plot the cross section polyline and the grid text. This can be useful for plotting on a section sheet that has pre-plotted grid lines and you want to plot only the section and text.

The Station Settings button displays another dialog for the station label settings including decimal places, size, layer, style, color, prefix, suffix, format type and position. The Circle Station option will draw a circle around the station label.
Label Scale: Will label the horizontal and vertical scale with the first section on each sheet.

Left Grid Offset Limit: Specify the length the grid lines are plotted to the left from the centerline or zero offset.

Right Grid Offset Limit: Specify the length the grid lines are plotted to the right from the centerline or zero offset.

Station Text Size Scaler: Specify the text size scaler for the station text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Station Text Size to 0.10 and the horizontal scale is 100.0, then the text height will be (0.10 * 100) or 10.0.

Grid Text Size Scaler: Specify the text size scaler for the axis text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Axis Text Size to 0.08 and the horizontal scale is 50.0, then the text height will be (0.08 * 50) or 4.0.

Horiz Grid Spacing: Specify the distance the vertical lines of the grid will be spaced.

Horiz Text Spacing: Specify the interval that text will be plotted below the grid lines.

Vert Grid Spacing: Specify the distance the horizontal lines of the grid will be spaced.

Vert Text Spacing: Specify the interval that text will be plotted to the left and right of the grid lines.

Grid Settings: Click this button to establish how text annotation is configured for the grid. There are setting for the grid lines and text for layer, linetype, color, decimals, style, size, prefix and suffix. Label Elevations Left Side Only: Enable this option if elevation labels are desired only on the left side of each section. Use Minus for Left Offsets: Enabling this option will show a minus sign (-) in front of all left offset distances. Label Zero Offset as: Use this setting to label the Zero Offset as '0', 'C/L' or 'Other' to specify a custom label. Grid Style: When using either the Vertical Stack option or the Pick Location option, indicate the desired style for the grid markings.

Draw Horizontal Label Box: Enabling this option will draw a table with desired labeling above or below each cross-section. By picking the Set button to the right, you can choose the data to be placed in the table. The Elevation, Offset and Description of each point on the cross section can be added to the table. If more than one Section file (.sct) is being drawn on the cross-section, you will also have the option of displaying the elevation difference between sections.
In the *Draw Horizontal Label Box* dialog, select from the *Available Fields* in the list on the left to populate the list of *Used Fields* on the right side. Once an item has been moved to the list of *Used Fields*, you can double-click on the Field to change settings and format for each Field. An example of the *Elevation Difference* option is shown below:

The *Row Title* for each field can be edited from the default to show a descriptive title. The *DZ* value in the Elevation Difference settings dialog allows you to specify which Section's elevations are to be subtracted from the other. This setting is critical to return the correct cut and fill depth values. In all field settings boxes, you have the ability to skip surface points in order to make the data more legible.

**Skip Subgrades:** Enable this option to skip all subgrades as may have been defined in Design Template files (.tpl).

**Skip Points:** Enable this option to skip points in the Section file (.sct) that were created using any of the *Create Section Points...* commands.

**Skip Overlaps:** Enabling this option will cause any overlapping text in the table to be skipped. Having this option enabled will disable the *Shift Overlaps* option.

**Shift Overlaps:** Enabling this option will shift any text in the table to the right so that it does not overlap preceding...
A sample cross-section with **Horizontal Label Box** is shown below:

![Graph](image)

<table>
<thead>
<tr>
<th>EG : Elevation</th>
<th>237.42</th>
<th>236.48</th>
<th>236.08</th>
<th>234.70</th>
<th>234.42</th>
<th>233.37</th>
<th>233.07</th>
<th>232.70</th>
</tr>
</thead>
<tbody>
<tr>
<td>EG : Offset</td>
<td>90.00</td>
<td>68.75</td>
<td>55.51</td>
<td>36.29</td>
<td>-1.24</td>
<td>21.45</td>
<td>56.51</td>
<td>72.96</td>
</tr>
</tbody>
</table>

Select the OK button to continue. If the Vertical Stack option was selected, the sections are immediately drawn to the active "space" (e.g. the Model or Layout) with the bottom center of the first section getting placed at 0,0. If the Pick Location option was specified, you will be prompted to specify the base location for each section. If the Sheets option was selected, the Sheet Drafting Parameters dialog box appears allowing you to specify all the settings for sheet plotting.

**Section File Sheet Drafting Parameters**
Choose Space: Indicate whether sheets are to be drawn to Paper Space (also known as a Layout) or to Model Space.

Layout Name: Indicate the name of the layout to which the first sheet should be drawn.

Tile Sheets: Enabling this option places all sheets in the specified Layout Name. The result is a vertical stack of sheets in the layout. Disabling this option allows additional layouts to be created each containing one sheet. As additional layouts are created, the name of each successive layout is incremented by a value of 1.

Plot at 1:1: Enabling this option draws the sections so that one unit horizontally in the section is equivalent to one plotted unit. The ratio of the Horizontal Scale:Vertical Scale determines the amount of vertical exaggeration.

Block Name: Specify the drawing name that will be inserted for each sheet. The default is SCTSHT1 which is included with Carlson Software and is located in the %AppData%\Carlson Software\Carlson Software\Sup\folder. You can use this or use a sheet block of your own design. The block should be drawn at a 1:1 scale since the program inserts it using the Horizontal Scale setting from the previous dialog. Click the Set button to browse/navigate to an alternate drawing file.

Set Sheet Attributes: For grid sheet block names that utilize attributes (useful for items such as sheet numbers, drawn date, drawn by, job name, etc), use this command to provide attribute values that will be placed for each sheet block:

![Set Sheet Attributes](image)

Find Sheet Attributes: This routine will scan the Block Name for any attribute definitions and return them to the dialog box so values can be established for each attribute.

Starting Page #: Indicate the starting page number to be applied to the plots through the use of the Set Sheet Attributes command.

Scan Block for Width/Height: Use this routine to scan the specified Block Name for its width and height. These values are populated into the Sheet Width and Sheet Height controls.

Sheet Grid Interval: Indicate the spacing between the grid lines in the sheet block. The routine will not draw the grid lines and uses this information to control the placement of each section onto the sheet.

Vertical Space Between Sheets: Indicate the amount of space that should be placed between sheets when the Tile Sheets option is enabled.

Rows of Sections
Per Sheet: Specify the maximum number of sections that can be stacked on top of each other on a sheet.

Space Between: Specify how much space will be placed between the top of the last section plotted and the bottom of the next section. For U.S. Customary based units, a value of 1 would be a good starting value.

Columns of Sections
Per Sheet: Specify how many columns of sections can be placed on each sheet.

Space Between: Specify the distance between the left edge of one section column edge and the right edge of the next column. This will generally be the area where elevation labels and station circle annotation will be placed. For U.S. Customary based units, a value of 2 would be a good starting value.
Label Grid Zero Offset: Enable this toggle if the zero offset location of each section should be labeled on each section.

Offset for 1st Section
Horizontal Offset: Specify how far from left edge of the sheet the first section will be placed on to the section sheet. The block SCTSHT1 has a 1" left margin.
Vertical Offset: Specify how far from bottom edge of the sheet the first section will be placed on to the section sheet. The block SCTSHT1 has a 1/2" bottom margin.

Preview: This button allows you to get an approximate idea of what the initial sheet will look like based on the current settings.

Back: This button allows you to return focus to the main dialog and make changes to any previous settings or cancel the routine.

Save Settings: This button allows you to save all the parameters settings to a file so you can easily recall them for another project.

Prompts

If the Pick Location option was specified, the program scans the station data and determines the minimum and maximum elevations, and proposes a datum elevation. If you have pre-plotted a grid sheet and want to reference another local grid coordinate, then change the datum elevation appropriately. The Pick Location type of plotting has the following prompts:

Station > 25.000 Min Elev > 1055.301 Max Elev > 1057.068
Change datum elev/<Select point that represents 0 offset elev 1050.0>: Pick a point
Station > 50.000 Min Elev > 1055.557 Max Elev > 1057.324
Change datum elev/<Select point that represents 0 offset elev 1050.0>: Pick a point

The program continues to prompt until the last station in the range specified is drawn. You can use the Cancel function (the Esc key) to stop plotting, if necessary.

If the Sheets option was specified with Model space as the destination, you can choose where to insert the sheet(s):

Select Starting Point for Row of Sheets <0.0,0.0>: Pick a point or press Enter to accept the default value specified

Sheet Sample
First, be sure that you are set to metric mode in Drawing Setup under the Settings menu. For our example, assume a 1:1000 horizontal scale. Once set, issue the Draw Section File command and click OK to reach the second dialog. There is a different block name for metric sections called schsht2.dwg which is located in the %AppData%\Carlson Software\...\Sup\ folder. Begin by setting the parameters for the second dialog as shown.
Third dialog with metric settings

Adjust settings as needed to achieve the desired look/layout.

**Pulldown Menu Location(s):** Civil > Sections, Field > Roads  
**Keyboard Command:** drawsct  
**Prerequisite:** A Section (.sct) file

---

**Section Report**

This command generates a report of a section file for the specified stations. The information contained in the report is determined by the settings in the Section Report Options dialog box.

---

**Decimal Places:** Specify the display precision for stations and elevations.

**Use Row-Column Report Layout:** When checked, offsets are reported in columns. Example reports showing the difference are shown below. Also when active, there is an option to **Line-Up Columns By Center Offset** which makes the zero offset column line up. Otherwise, the columns are lined up by the left most offset.

**Use Report Formatter:** Report output is directed to the Report Formatter which allows for custom reports, as well as being able to export the report to Microsoft Excel or Access.

**Report Descriptions:** Controls whether the descriptions for each section point are reported.

**Specify User-Entered Offsets To Report:** After choosing OK from this dialog, the program will prompt for additional offsets to report with interpolated elevations. These are for offsets that don't already exist as section points in the section file.

**Report Slopes:** Will report the slope between section points. Specify how to report the slopes, either none, percent, ratio, or auto format. Auto format means that slopes less than 10% are reported in percent, while greater slopes are reported as ratios.
**Stations to Report:** Specify either a range and interval of stations to report or enter each station one at a time.

**Station Direction:** This setting controls the order of the stations for the report.

**Grades to Report:** This applies to section files that contain subgrades. For these section files, you can choose which grades to report (top surface or subgrades). All is also an option.

**Description Match:** This field can be used to filter the section points by their description.

**Report Elevation Difference:** Reports section elevations by Reference Grade Point, Section File or choose none.

**Reference Grade Point:** Specify the reference grade ID. Only available if Grade Point option is selected, as mentioned above.

**Select Reference Section File:** Specify a reference file. Only available if Section File is chosen, as mentioned above.

**Elevation Difference at Offset Interval:** Used if there is an elevation difference. The next three options only available if Elevation Difference at Offset Interval is clicked.

**Offset Interval:** Value required.

**Left Limit/Right Limit:** Values required.

**Prompts**

- **Section Report Options dialog** choose options
- **Section File to Report dialog** choose existing file
- **Starting station for report** \(<0.000>: \) press Enter
- **Ending station for report** \(<1147.478>: \) press Enter
- **Station interval (A for All)** \(<100.0>: \) press Enter
Offset & Elevation Report/Plot

This command calculates the offset and elevation at points along a polyline on a section grid. The results can be drawn on the grid or just displayed on the text screen. The offset and elevation are either calculated for each vertex of the polyline or at user specified points. This command can also be used as a section inspector. As you move the cursor across the section, the offset, elevation and slope are reported in real-time in a pop-up window.

The Prompt For Snap toggle controls whether the command will present the snap dialog as you pick points to figure the offset and elevation at. The Grid Starting Elevation edit box allows you to input the beginning elevation of the local grid that you are designing in. Use the Scale edit boxes to set the proper horizontal and vertical scales for your design environment. The Label each vertex of grade polyline option will draw the offset-elevation label above each point in the selected polyline. There are also settings to control the prefix, suffix and decimal precision for all the labels.

Prompts

**Section Offset-Elevation Settings dialog** Choose the scales and base elevation that match your section grid.

Pick center grid point [int on]: Pick the grid point at the zero offset and base elevation. The intersection osnap mode is on.

Pick grade polyline: *select polyline*

Pick vertical alignment for text: *pick point above the polyline*
Offset & elevation at each polyline vertex

**Pulldown Menu Location:** Sections  
**Keyboard Command:** offelev  
**Prerequisite:** Must plot the polyline that represents the grade

### Draw Mass Diagram

This command draws a mass diagram uses data from a .MAS file created by commands such as Process Road Design, Calculate Section Volumes or Edit-Process End Areas. The diagram options are set in the dialog shown here. These settings are a subset of the settings in the Draw Profile command. Please see the Draw Profile section of the manual for a description of these settings.

#### Prompts

**Mass Diagram File to Read dialog** choose .MAS file  
**Draw Mass Diagram dialog** Make selections.
Mass Diagram Report

This command creates a report for mass diagram data from a .MAS file created by commands such as Process Road Design, Calculate Section Volumes or Edit-Process End Areas. The Report Formatter is used to specify the layout of the report with options to output to Excel and databases. The report includes the stations and accumulated cut/fill volumes. Positive amounts indicate more fill than cut and negative is for more cut than fill.

Prompts

Mass Diagram File to Read dialog choose .MAS file
Number of decimal places <2>: press Enter
Report Formatter dialog Make selections.

Mass Diagram

File: C:\sample\simo2.mas

Station Mass
0+00.00 17.02
0+50.00 4789.41
1+00.00 10174.48
1+50.00 15215.27
2+00.00 18363.56
2+50.00 18467.06
3+00.00 16772.88
3+50.00 13227.30
4+00.00 7898.93
4+50.00 1418.09
5+00.00 -4995.74
Prerequisite: .MAS file

Mass Haul Report
This command reports the mass haul amounts and stations of balance. Before running this command, the mass haul data file must be created with another routine such as Process Road Design, Calculate Section Volumes or Mass Haul Analysis. The mass haul data file is a profile (.pro) format with stations and mass haul volume instead of the stations and elevation of the typical profile.

The Mass Haul Report has the stations and accumulated cut/fill volume balance up to the stations. The Report Balance Stations Only option makes a report for the stations where the cut/fill is balanced.

Mass Haul Report
File: C:\SAMPLE\MASSHAUL.PRO

<table>
<thead>
<tr>
<th>Station Balance</th>
<th>Cut/Fill Volume</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+92.266</td>
<td>0.000</td>
</tr>
<tr>
<td>1+53.409</td>
<td>0.000</td>
</tr>
<tr>
<td>7+04.560</td>
<td>0.000</td>
</tr>
<tr>
<td>11+97.656</td>
<td>0.000</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Sections > Cut/Fill Analysis
Prerequisite: Mass haul data file (.pro)
Keyboard Command: mhreport

Mass Haul Analysis
This command will determine the volume and haul distance for each group of net cut and net fill station ranges along a road. The program calculates the optimized cut to fill movements so that the total volume-distance moved is minimized.

You will first be prompted to select the Existing Ground section file and the Design Surface section file or on End Area (.ew) file. These files will be used to determine the Mass Haul quantities. If you do not have either of these files, you can create them using the different Create Sections commands under Roads. After you selected your section (.sct) files or (.ew) file, the following dialog will appear.
Range of Stations: The program will pick up the range of stations determined by your section files. In this field, you can modify the range of stations to process. The Settings button brings up another dialog with more station options:

Cut/Fill Starting/Ending Stations: The Cut and Fill Starting and Ending Stations are for tapering the end areas at the start and end of the section range down to zero beyond the station range.

Cut/Fill Gaps: Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes.

Shrink/Swell Factors: The Shrink Factor is multiplied by the fill quantities and the Swell Factor is multiplied by the cut quantities.

Report Precision: This setting controls the number of decimal places to use in the report.

Use Report Formatter: The Report Formatter will allow you to customize the information reported by the Mass Haul Analysis.

Calculate Centroids Using Centerline: This option will find the center offset for each Cut/Fill area and use a centerline to adjust the station interval along curve segments for the end area volumes.

Use Rock Section For Rock Volumes: This option will use a third section file for reporting rock cut quantities.

Extend Shorter Sections to Longer: This option will find your longest section and match the length of all your other sections to it.

Interpolate Missing Section Stations: Toggle this on to interpolate any missing stations so that the Mass Haul report can use all the stations.

Topsoil Adjustment: This will apply a Topsoil Removal/Replacement definition from the Template Adjustments to adjust the sections.
**Mass Diagram:** This will create a Mass Diagram of the cut/fill balance by station. This data is stored in a profile file (.pro) format file, and you can use Draw Profile to draw it.

![Mass Haul Settings](image)

**Mass Haul Settings**

The Haul Distance ranges are for reporting the cut to fill volume movements by the different haul distance ranges. For each range of stations with a net cut volume, the report has a row for the net fill station range the cut was moved to, the amount of cut/fill, the volumes per haul distance range, the average haul distance per range and the overall haul distance average. The In Station Volume is the amount of cut and fill that occurred at the same station and doesn't have to be hauled to another station.

The purpose is to evaluate how far the cut has to be moved, and the haul distance ranges can be used to separate the distances for different types of equipment. The External Hauls can be used to specify the stations along the road for borrow pits or dump piles. The program will use volume from these external hauls when the cut/fill of the road does not balance.

**Mass Haul Analysis**

Existing Section: > C:\Takeoff\Drawings\demo2-og.sct
Final Section: > C:\Takeoff\Drawings\demo2-fn.sct
Volumes per Range Average Haul per Range
Net Cut Net Fill Total In Sta Haul 0 200 Over 0 200 Over
Station Station Cut(CY) Import Fill(CY) Export Volume Volume Volume 200 500 500 200 500 500 Overall Avg
0+00.000 1441 1+00.000 1251.729 0.000 1251.729 0.000 1251.729 1127.595 124.134 124.134 0.000 0.000 153.135
20+00.000 20+50.000 1251.729 0.000 1251.729 0.000 1251.729 1127.595 124.134 124.134 0.000 0.000 153.135
13+80.000 12+00.000 887.367 0.000 887.367 0.000 887.367 239.938 647.429 542.651 104.777 0.000 164.552
209.534 0.000 179.887

*Chapter 6. Civil Module* 1441
13+70.000 15+05.340  
13+90.000 15+23.200 95.633 0.000 95.633 0.000 95.633 51.559 44.074 44.074 0.000 0.000 137.235 0.000 0.000 137.235

13+80.000 14+20.000  
14+20.000 14+50.000 216.434 0.000 216.434 0.000 216.434 96.872 119.563 119.563 0.000 0.000 38.560 0.000 0.000 38.560

14+60.000 14+50.000  
14+80.000 14+60.000 43.333 0.000 43.333 0.000 43.333 18.620 24.712 24.712 0.000 0.000 11.818 0.000 0.000 11.818

14+70.000 15+00.000  
15+00.000 15+14.270 82.194 0.000 82.194 0.000 82.194 29.738 52.456 52.456 0.000 0.000 24.395 0.000 0.000 24.395

Total: 9808.744 0.000 69788.700 0.000 74189.760 66786.400 7403.360 1288.814 930.060 783.423 127.043 209.534 0.000 130.579

Pulldown Menu Location: Sections  
Prerequisite: A Section Alignment File and Existing and Road Sections  
Keyboard Command: masshaul

**Cut/Fill Width Analysis**

This command generates a report of the horizontal width of cut and fill areas between two cross sections. The report generated can take into account the cut, the fill or both. For example, the Process option for Cut only will report only the grading areas as the cut end areas. The options for this command are set in the dialog shown. The Report Width At Interval option reports the width of each area is reported at different elevations set by the Elevation Interval. For the Report Elevation At Width option, the elevation is calculated for where the area has the Target Width. For the Report Average Width/Height option, the average width and height is calculated for each area. The Report Tie Points option reports the intersection points between the original ground and design sections. The Use Report Formatter option allows for customized reports and output to Excel and databases.

---

**Prompts**

Section File (Existing Ground) dialog choose existing .SCT file  
Section File (Final Ground) dialog choose the other existing .SCT file  
Cut/Fill Analysis dialog Make selections.
Width Analysis Report:

Cut/Fill Section Report
Target Width: 20.00
Section 1: C:\data\simo2.sct
Section 2: C:\data\final.sct
Station: 0+10.000
Fill Area: 153.289
  Target Width at 108.07
  Area Above Target Width: 72.48
  Area Below Target Width: 80.81
  Average Width: 12.19
  Average Height: 2.95
  Elev: 110 Width: 25.97
  Elev: 105 Width: 10.65
  Elev: 100 Width: 2.86
  Elev: 95 Width: 0.00

Tie Points Report:
Section File 1: C:\sample\rehab1\exist-rd.sct
Section File 2: C:\sample\rehab1\grind.sct

Station Fill Area Tie Offset Width Tie Offset Left Tie Offset Right Tie Elev Left Tie Elev Right
732+58.510 12.941 24.000 -12.000 12.000 927.312 927.337
732+75.000 13.485 24.000 -12.000 12.000 927.381 927.288
733+00.000 13.554 24.000 -12.000 12.000 927.505 927.271

PullDown Menu Location: Sections > Cut/Fill Analysis
Keyboard Command: cfwidth
Prerequisite: Two section .SCT files

Cut Sheet
This command compared a base grade section (.SCT) file with a final grade section (.SCT) file. It then reports the cut or fill values between these two sections files. The cut and fills are calculated at two offsets in a specified range of stations. The report shows a column of cut and fill values for each offset as shown below. The two section .SCT files should have matching stations, because the program compares the offsets and elevations of a station in the first section file with the offsets and elevations of the same station in the second section file.

Prompts

Base Grade Section File dialog choose existing .SCT file
Final Grade Section File dialog choose the other existing .SCT file
Left offset: -10
Right offset: 10
Range of stations: 25.0 to 275.0
Enter the starting station to process <25.0>: press Enter
Enter the ending station to process <275.0>: press Enter

Cut Sheet Report

<table>
<thead>
<tr>
<th>Station Offset</th>
<th>CL Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td>25.00</td>
<td>+4.55</td>
</tr>
</tbody>
</table>
Design Regrade

This command allows you to create final sections and have the offset, grades, and end area dynamically displayed and calculated while in the design process. This command works on a section grid that has an existing grade polyline which is used as the reference for the cut/fill calculations. The final section points can be entered as offset-elevation or picked on the screen. As you move the crosshairs on the graphics screen, the offset, elevation, slope percent, slope ratio, and end areas are displayed in a real-time pop-up window. When picking design points, you can use this real-time window to check the slope and other values and get these values close to the desired amounts. Then after the point is picked, a snap dialog appears (if the snap option is active) which allows you to set a slope or other value to a fixed amount (i.e. set the slope to 2.00% from 1.97%).

There are several options when specifying the final section points. The 'T' (Tie) option goes from the last final section point to intersect the existing grade at the specified slope. The 'F' (Force grade) option prompts for a slope percent or ratio that is used to set the slope between the last two regrade points. The program expects the final section points to be entered from left to right, but you can reverse the entry order by using the 'S' (Switch Direction) option. The 'P' (Pick existing) will use a point on the existing grade that is closest to the picked point. This is the same as the object snap nearest. The 'M' (Modify) option allows you to change an already placed regrade point. The program will prompt you to pick which regrade point to change. You can then pick a new position for it. This option allows the adjusting of already placed regrade points to help balance the cut/fill.

The command starts with a settings dialog. The Prompt for Snap toggle controls whether the command will present the snap dialog for each section point that is picked on the screen. The Grid Starting Elevation edit box allows you to input the beginning elevation of the local grid that you are designing in. Use the Horizontal and Vertical Scale edit boxes to set the proper horizontal and vertical scales for your design environment. The Text Scale value is multiplied by the horizontal scale to set the text size of the cut/fill end area labels. The regrade can be saved in a .sct file with the Output Regrade to Section File option. The Output Regrade to Earthworks File option stores the cut and fill values of the regrade to an earthwork (.EW) file that can be used in the Print Earthwork File Report command.
Prompts

Design Regrade Settings dialog Make choices and click OK.
Pick Center Point of Grid [int on]: pick a point Pick the point where the local grid lines intersect at the 0 offset and datum elevation.
Select the existing grade polyline: select polyline
First offset or pick a point (P,Help): pick a point If you have the snap prompting on then each time you pick a point from the screen the dialog below will appear.
Second offset or pick a point (U,S,T,P,M,Help): pick a point If you make a mistake on one of the points you select than use the U option to undo or delete your last entry.
Next offset or pick a point (U,F,S,T,P,M,Help): F If you want to type in a specific grade use the Force grade option.
Ratio/<Percent grade between 0.0 and 30.2>: -.2
Next offset or pick a point (U,F,S,T,P,M,Help): pick a point
Next offset or pick a point (U,F,S,T,P,M,Help): 75
Percent grade/Ratio of slope/<Elevation>: 445
Next offset or pick a point (U,F,S,T,P,M,Help): press Enter Press Enter to end the command.
Pick point for label (Enter for none): pick a point to label the cut/fill end areas
Enter station of regrade: 100

**Pulldown Menu Location:** Sections

**Keyboard Command:** regrade

**Prerequisite:** Must plot the polyline that represents the existing grade

### Calculate Haul Factors

After creating a regrade polyline with *Design Regrade*, this command will calculate how far and how much earth must be hauled in order to obtain the regrade from the existing grade. Areas from cut will be moved into areas of fill. In order to be optimal, this command expects even amounts of cut and fill. Haul factors measure the amount of earth moved times the distance. There is also an option to label the cut and fill areas.

### Prompts

- **Horizontal Scale** <50.0>: *press Enter*
- **Vertical Scale** <50.0>: *press Enter*
Select the existing grade polyline: pick the polyline
Select the regrade polyline: pick the polyline
Label areas (<Yes>/No)? press Enter
Text size <4.00>: press Enter This defaults to the horizontal scale times the text scaler.
Enter the report title <Haul report>: press Enter
Write report to file (Yes/<No>)? press Enter
Write report to printer (Yes/<No>)? press Enter

Haul factors for a regrade:
Haul report
Haul factor 344.43, Amt 27.32, Dist 12.61 from cut 1 to fill 1
Haul factor 15.99, Amt 1.45, Dist 11.04 from cut 1 to fill 2
Haul factor 74.78, Amt 4.51, Dist 16.60 from cut 2 to fill 2
Haul factor 2339.17, Amt 58.07, Dist 40.28 from cut 2 to fill 3
Haul factor 2945.88, Amt 62.10, Dist 47.44 from cut 3 to fill 3
Haul factor 1038.63, Amt 11.20, Dist 92.72 from cut 4 to fill 3
Haul factor 116.30, Amt 6.09, Dist 19.09 from cut 4 to fill 4
Haul factor 50.81, Amt 2.99, Dist 16.98 from cut 4 to fill 5
Total cut: 173.73, Total fill: 174.93
Left over cut: 0.00, Left over fill: 1.20
Haul factor (dist*amt): 6925.98
Haul ratio (haul factor/total amt): 39.87

Sections to 3D Polylines
This command creates 3D polylines from a section (.SCT) file. Besides the section file, a centerline polyline, centerline file or section alignment (.MXS) file must be specified to define the plan view location of the 3D polylines. The elevations for the 3D polylines come from the section file. These 3D polylines can then be used by other Carlson routines to create surface models.

Typically, the 3D polylines are drawn as cross-sections perpendicular to the centerline at each station. When using a polyline centerline instead of the .MXS file, there is an option to draw by connecting similar descriptions to make 3D polylines parallel to the centerline. For example, if the section file has descriptions for each section point then you can draw 3D polylines for EP, SHD, TIE, etc.

Prompts

Layer Name for 3D Polylines <3DXSEC>: press Enter
Align sections by MXS file, centerline file or polyline [MXS/Centerline/<Polyline>]? press Enter
Choose Section File to Process Select the .sct file
Range of stations: 1.14 to 1605.25
Enter the starting station to process <1.14>: press Enter
Enter the ending station to process <1605.25>: press Enter
Draw sections or offset polylines by description [<Section>/Offset]? press Enter
Type of centerline [<ROadway>/RAilroad]? press Enter. This option chooses between roadway and railroad methods for stationing along curves.
Select centerline polyline: pick the polyline
Enter the centerline starting station <0.0>: press Enter
Draw perimeter of sections [Yes/<No>]? Y This option will connect all the left most offsets and right most offsets together with a 3D polyline.
Use reference profile to interpolate between sections [<Yes>/No]? N for no. This option will prompt for a profile
to use for interpolating elevations along the 3D polylines between the section stations. This improves the accuracy when the profile goes through vertical curves. Without the profile, the 3D polyline elevations will be straightline interpolated between the sections.

**Draw all template ids or specific ids and offsets [All/<Specific>]? press Enter for Specific**

**Enter Offset or Description to draw: EP**

**Keyboard Command:** scto3dp

**Prerequisite:** A section (.SCT) file

### Sections to Points

This command creates Carlson points using a section (.SCT) file to define the point elevations. The x,y position of the points are calculated based on the station and offset along a centerline polyline. These points are stored in the current coordinate (.CRD) file and can also be plotted in the drawing. Points can be created at each station in the section file or at a set station interval. The range of stations to process can also be set. The Description Match field can be used to filter the offsets and only create points with matching descriptions (e.g. only "EOP" offsets). The Create points at fixed offsets option can be used to make points at user-specified offset distances. The program will interpolate the elevations for these points by interpolating from the neighboring offsets. The is both a Centerline by Polyline or by CL File option. The CL File option will prompt for an existing centerline (.CL) file. The Reduce Points option will skip creating points for the same offset between stations if the x,y position and elevation change is less than the offset tolerance. Essentially, when a series of offsets are on a straight line (no vertical and no horizontal curve) then only the starting and ending points are needed and all the intermediate points can be skipped. For example, the Reduce Points routine will look at the left side EOP offset points at stations 1+00, 1+05 and 1+10 and if these three points make a straight line then the point for station 1+05 can be reduced. The Offset Distance is the tolerance that Reduce Points using for testing whether the middle point (offset point at station 1+05) can be reduced. The distance for the middle point is calculated as the perpendicular distance from the middle point to the line between the two end points. Both the horizontal and vertical distances are checked.
Prompts

Sections to Points Settings dialog

Coordinate File to Process Choose a .CRD or other coordinate file to add the points to. This prompt only occurs if no coordinate file is current.

Choose SCT file to read *pick the cross section file*

Range of stations: 3.34 to 750.00

Enter the starting station to process <3.34>: press Enter

Enter the ending station to process <750.00>: press Enter

Select centerline polyline: *pick the polyline that defines the stations*

Type of centerline [<ROADway>/RAilroad]? RO

Enter the centerline starting station <0.0>: press Enter

Created 65 points.

Keyboard Command: scsctopt

Prerequisite: A .sct file and polyline centerline

Design Section Staging

This command takes a design cross section and splits it into two stages for cases when the design surface will be built in stages. There are two staging methods.

The Offset method splits the design section at a specified offset with the left side as one stage and the right side as the other stage. This method applies to the situation of designing a partly completed road or regrade. For example, if a four lane road will be built two lanes at a time, then the offset method can be used to split the design section with two lanes on the left side of the offset and the other two lanes on the right side. Using an existing and a final grade section file, the program will create four new sections files for the finished existing sections, finished final sections, remaining existing sections, and remaining final sections. The source existing and final section files should have matching stations. There is an option to process a range of the possible stations from the section files. The complete part of the road can be either on the left or right side. The pivot point is a cross section offset where the completed part ends. From this point, the final grade will connect to the existing grade by a line at the specified slope.

The Description method uses a specified description from the existing ground section file plus an offset from this description. Then the existing section is overlaid onto the design section for the offset zone around this description. This method applies when a portion of the existing ground stays intact when the first stage of design is built and then this remaining portion of the design is done as the second stage. For example, this applies to improving railroads where the existing track is left undisturbed while the work for the new bed is prepared. In this case, the existing section file should have a description for the offset position of the existing track centerline. Then you specify the buffer offset around this centerline. From the resulting left and right offsets, the program ties the existing section into the design at a specified slope.

Prompts

For Offset Method:

Select Existing Sections File Choose the cross sections file.

Select Final Sections File Choose the cross sections file.

Enter slope as percent grade or slope ratio [Percent/<Ratio>]? press Enter

Enter the fill slope ratio <2.0>: press Enter

Enter the cut slope ratio <2.0>: press Enter

Stage by side from offset or overlay existing at description [<Offset>/Desc]? press Enter

Place road on left or right [<Left>/Right]? press Enter

Range of stations: 50.0 to 100.0
Enter the starting station to process <50.0>: press Enter
Enter the ending station to process <100.0>: press Enter

Apply same pivot offset to all stations [Yes/<No>]? Y

Enter the pivot offset (enter left offsets as negative) <0.0>: 5.0

SCT File dialogs Enter new .SCT file names for 1) existing road .SCT file, 2) final road .SCT file, 3) remaining existing .SCT file and 4) remaining final .SCT file.

Here is an example of the Offset method showing the original existing and design sections and then the four new sections files for the finished existing sections, finished final sections, remaining existing sections, and remaining final sections that the routine creates.

For Description Method:

Enter slopes as percent grade or slope ratio [Percent/<Ratio?>]? press Enter

Enter the fill slope ratio <2.0>: press Enter
Enter the cut slope ratio <2.0>: press Enter

Stage by side from offset or overlay existing at description [<Offset>/Desc]? D for description

Existing section target description: CL

Range of stations: 100.00 to 100.00

Enter the starting station to process <100.00>: press Enter
Enter the ending station to process <100.00>: press Enter

Enter the buffer offset <0.0>: 4

Here is an example of the before and after for the Description method.

Pulldown Menu Location: Sections
Keyboard Command: scststage
Prerequisite: Existing and final grade section files (.SCT)
Draw Pipe 3D Polyline

This command creates a 3D polyline that represents a pipe. The points can be either picked on screen or specified by point number in the current coordinate file. This command is a convenient way to make 3D polylines that can become "pipe polylines" used for capturing their profile positions, leading to circular or elliptical or even square plots of the pipes or culverts within Draw Profile. However, this command is not required nor sufficient to make a pipe polyline useful in the Draw Profile command. Pipe polylines are made only by converting 3D polylines into pipe polylines using the adjacent command, Assign Pipe Width to Pline.

Prompts

Layer Name for 3D Poly <PIPE>: press Enter
Prompt for elevations (.XY filter) (Yes/No)? Y for yes
Undo/<Pick point or point numbers>: pick a point
Elevation <0.0>: 554.12
Undo/<Pick point or point numbers>: pick a point
Percent slope/Ratio slope/Elevation <0.0>: 553.72
Undo/Close/<Pick point or point numbers>: press Enter
Draw another 3D polyline (Yes/No)? press Enter

Pulldown Menu Location: Sections
Keyboard Command: drwpipe
Prerequisite: None

Assign Pipe Width to Polyline

This command is described in the Profiles Menu section of Help, under Profile Utilities.

Slope Stake Report

This command creates a slope stake report using cross section data with stations, offsets, elevations and descriptions. The program uses the data point descriptions to identify and catch and pivot points and other data points to report. Besides processing a section file (.sct), the program also uses a centerline file (.cl) for reporting coordinates for the data points.
After selecting these files, there is a dialog for the report options. The Starting and Ending Stations control the range of stations to report. The Side To Process option selects whether to report the slope stake for the left or right of the centerline or both sides. The Catch ID is the section data point description for where the section ties into existing ground. The Pivot ID is the description for the hinge point at the beginning of the cut/fill slope. The Catch and Pivot ID's are required for the report. The Report ID's are optional additional section break points to include in the report. They should be entered in outside template to inside order. The Select button shows a graphic of the section data with toggles to select which section points to report. You can pick any combination of surface or subgrade points. Don't include the Catch ID or Pivot ID in the Report IDs because those IDs are already reported. The ROW ID is optional for including the ROW in the report. Typically, the ROW data is in the existing surface sections instead of the final sections. In this case, the Use Separate ROW Section File option can be used to specify the section file with the ROW data. The Report Stake Offset Points option adds an offset point that can be used for stakeout. The offset amount can be relative to the catch point or to the centerline. A second offset can be used for orientation with the first offset. The program reports the distance from the offset point to the catch point.

The Label Options section has prefix and suffix settings to add to the report values. There are also settings for the labels to use for the Stake, ROW and Cut/Fill names. There are also controls for the decimal places for the report values.
After specifying the options, the program uses the Report Formatter to generate the report. The available fields are point name, station, offset, northing, easting, elevation, cut/fill label, horizontal distance, vertical distance, slope percent and slope ratio. You can select which fields to report and their order. The field labels and decimal precision is controlled by the Report Formatter. The report can be output to the Report Viewer or Excel.

Slope Stake Report

Sections: C:\sample\road.sct
Centerline: C:\sample\demo3.cl
Station: 0+00.00
From Name To Name Horizontal Vertical Cut/Fill Slope% Ratio
Stake Offset TIE 5.000 0.000 Flat 0.00 999.900
TIE SH 5.255 5.255 Cut 100.00 1.000
SH EP 6.000 0.120 Cut 2.00 50.000
EP CENTER 12.000 0.480 Fill 4.00 25.000

You can also use the Mirror the columns option in the Report Formatter to layout the report like this:
Sections: C:\sample\final.sct
Centerline: C:\sample\demo.cl
Station: 0+00.00
CP SH EP CENTER EP SH CP
-19.53 -18.00 -12.00 0.00 12.00 18.00 19.53
1038.19 1038.57 1038.45 1038.69 1038.45 1038.57 1038.19
-25.00% 2.00% -2.00% -2.00% 2.00% -25.00%
F 0.38 C 0.12 F 0.24 F 0.24 C 0.12 F 0.38
@ 1.53 @ 6.00 @ 12.00 @ 12.00 @ 6.00 @ 1.53

Prompts

Section File To Process Select a .sct file.
Centerline File To Process Select a .cl file.
Slope Stake Report dialog Choose report options.
**Report Formatter dialog** Configure and display report.

**Pulldown Menu Location:** Sections > Section Utilities  
**Keyboard Command:** ssreport  
**Prerequisite:** A section and a centerline file

---

**Extend Sections to Offset Limits**
This command extends the offsets to the left and right limits for each station in a section file. The left and right offset limits are defined in the section alignment (.MXS) file. The elevations for the extended offsets can be extrapolated from the last slope from the existing offsets or the elevations can be carried flat from the last offset elevation. For example, consider section station with a left most offset of -192.5 and a right most offset of 197.3. If the MXS file had offset limits of 200 for left and right, then this routine would assign offsets with elevations at offsets -200 and 200. The resulting section file can be saved to a separate section (.SCT) file or overwrite the original SCT file.

**Prompts**

Select Section Alignment File *select .MXS file*  
Section File to Read *select .SCT file*  
Extend last slope or use last elevation *[<Slope>/Flat]?* *press Enter*  
Choose SCT file to Write *specify new .SCT file name*

---

**Slope Zone Section Analysis**
This command reports the cut/fill areas and volumes within given ranges of slopes. There is an option to use another section for cut/fill reference.

**Prompts**

Select Section to Process *Select .SCT file*  
Select Slope Zone dialog  
Report slope or horizontal area *[<Horizontal>/Slope]?* *S*  
Slope format *[<Percent>/Ratio]?* *press Enter*  
Greatest slope % of zone 1: *3*  
Greatest slope % of zone 2: *press Enter*  
Starting station to process *[<0.000]>:* *press Enter*  
Ending station to process *[<0.000]>:* *1000*  
The Standard Report Viewer creates a report called Section Slope Zone Analysis Report.

**Keyboard Command:** setzone  
**Prerequisite:** .SCT file
Regrade Fill Slope

This command is used on stockpile projects to regrade the fill slopes of the cross sections with less steep slopes while maintaining the same end areas. The slope portion of the cross section to regrade is identified by entering the section descriptions for the top and bottom points.

Prompts

Select existing section file Pick a section file to read
Specify new section file to Output Enter a section file to create
Target Slope Percent: 80
Top of Slope Offset Description: TB
Bottom of Slope Offset Description: BB

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: regrade_slope
Prerequisite: A section (.SCT) file

Overlay Section File

This command will create a section file at given cross slopes and minimum overlay from a reference section file. An existing and a proposed .SCT file must be selected, along with additional section information. A choice between Overlay Value or Proposed Elevation must be made. When the Overlay Value option is chosen, a Minimum Amount of Overlay must be entered, and the Slope values must be defined. You are allow to set up slope transition values for certain station ranges. When the Proposed Elevation option is chosen, a Proposed Centerline Elevation value must be entered.
Prompts

Overlay Section Data dialog Select file names and options, click OK
Report viewer creates a proposed section file report.

Pull down Menu Location: Sections > Section Utilities
Keyboard Command: sct_overlay
Prerequisite: A .SCT file

Average Section Files
This command will average a section file for a given station range. A source file to process must be selected to get things started. A starting station to average and a last station to average must then be entered. A new .SCT file will
be created as a result.

**Prompts**

Select Source Section File to Process Select a SCT file.
Starting station to average <0.000>: press Enter
Last station to average <1614.160>: press Enter
Section File to Write Select a SCT file name and folder.
Pulldown Menu Location: Sections, Section Utilities >
Keyboard Command: avgsct
Prerequisite: A .SCT file

**Merge Sections**

This command combines a range of stations of one section and a range of stations of a second section. The stations, offsets and elevations in these two ranges can be stored in a new file or they can overwrite an existing profile. Two .SCT files are required.

**Prompts**

First Section File to Merge select an existing .SCT section file
Starting station to merge <0.000>: press Enter
Last station to merge <1614.160>: press Enter
Second Section File select another existing .SCT file
Starting station to merge <0.000>: press Enter
Last station to merge <1310.050>: press Enter
Section File to Write Enter a new .SCT file name and choose folder

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: mergesct
Prerequisite: Two section files

**Compare Section Files**

This command will report the differences between two section files. The report includes differences in offsets or elevations for the section data points. Also, the report includes stations that exist in one file and not the other. Here is a sample report.

Compare Section Files

1st Section File: C:\sample\final1.sct
2nd Section File: C:\sample\final2.sct

<table>
<thead>
<tr>
<th>Station</th>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6+00.000</td>
<td>10.000</td>
<td>1007.873</td>
<td>EP</td>
<td>10.000</td>
<td>1008.003</td>
<td>EP</td>
</tr>
<tr>
<td>6+00.000</td>
<td>22.799</td>
<td>995.074</td>
<td>TIE</td>
<td>22.914</td>
<td>995.089</td>
<td>TIE</td>
</tr>
<tr>
<td>6+50.000</td>
<td>10.000</td>
<td>1008.906</td>
<td>EP</td>
<td>10.000</td>
<td>1009.208</td>
<td>EP</td>
</tr>
<tr>
<td>6+50.000</td>
<td>21.735</td>
<td>997.170</td>
<td>TIE</td>
<td>22.062</td>
<td>997.145</td>
<td>TIE</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Sections, Section Utilities >
Keyboard Command: comparesct
Prerequisite: A .SCT file

**Move Section Leader Labels**
This command custom positions section labels together with leaders. The section labels must be created with the Draw Break Point Leader option with the Draw Section File command. When the sections are redrawn, any custom positions done by this command are retained.

![Before and after of Move Section Leader Labels to clean up label overlaps with grid lines](image)

**Prompts**

Select section label to move: *pick a text label*
Pick label position: *pick a new position for the label*
Select section label to move (Enter to end): *press Enter*

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: sctmove
Prerequisite: section labels with leaders

**Update Sections from Polylines**
This command is used to update section (.SCT) files from manual changes made to polylines originally created by Draw Section.

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: update_sct_from_dwg
Prerequisite: Drawn Sections

**Review Section Links**
This command shows a list of all the section links that the program knows about in the current drawing. These links are between the section files and the drawn sections in the drawing. These links are created by the Draw Sections command. You can use the Remove button to remove links for any obsolete sections or if you don't want to link a certain section. You can also reassign a link in case the location of the section file has changed.
Pulldown Menu Location: Sections->Section Utilities
Keyboard Command: scdict
Prerequisite: none

Section ID
This command is used to pick a section drawing entity and then report the source section file name.

Prompts

Select section entity to identify: select entity

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: scid
Prerequisite: A .SCT file

Calculate Section Volumes
This command will read two section files and compute the cut and fill end areas and volumes. It computes the sections volume in the order they appear in the file. If you need to sort the stations in sequential order use the Input-Edit Section File command. Begin by selecting the base section file then the final section file. After specifying the input files the Calculate Section Volumes dialog appears. The settings can then chosen and customized to match your reporting needs. There is an option to apply topsoil removal/replacement adjustments, as well as support for processing sections with subgrades.
Range of Stations to Process: Specify the range of stations to process. Separate stations with a hyphen as shown. The Settings button brings up another dialog with more station options:

Cut/Fill Starting/Ending Sta.: Volumes are calculated using end areas between the range of stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise, the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station.

Cut/Fill Gaps: Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes.

Fill Shrink/Cut Swell Factor: Allows you to specify a value that the volume calculated will be multiplied by.

Report Precision: Specify the decimal precision for the report.

Use Centerline to Calculate Centroids: When checked, the program will calculate the centroids using a centerline (.CL) file. You will be prompted to select the centerline file.

Use Centerline for Station Equations: This option applies to section files with stations numbered using station equations. This option will use the station equations defined in a centerline file to remove the station equations from the section file stations for calculating the true end area distances. You will be prompted to select the centerline file.

Use Report Formatter: This option allows for customized report layout and contents. Otherwise a standard report
Report Centroids: Specify whether or not to report centroids.

Calculate Rock Volumes: When checked, you will be prompted to select a third section (.SCT) file that will be used to calculate rock quantities.

Calculate Overexcavation: When checked, calculates volume of overexcavation. See diagram.

Report Cut/Fill Text: Specify whether or not to report cut/fill at each station.

Report Cut/Fill Differences: Adds a running total of the cut to fill balance at each station to the report.

Report Cumulative Cut/Fill: Adds a running total of the cut/fill at each station to the report.

Extend Shorter Sections to Longer: If checked, shorter sections are lengthened to the same left and right offset extents as the corresponding longer sections.

Interpolate Missing Section Stations: If checked, the missing stations are accounted for in the calculations.

Breakout Quantities by Staging: This option breaks out the cut and fill end areas and volumes according to user defined offsets along the road. The "Slope Format" determines how each stage will tie back into the road.

In the example above, volumes will be reported separately for the left side of the road, the inside right lane (offset 0-10), the outside right lane (offset 10-20), and then the remainder right side of the road will automatically be reported as the "Last Stage".
Topsoil Adjustment File: This optional input file applies topsoil removal and replacement for the calculations. See the Topsoil Removal/Replacement command for more details on the .TOP file.


End-Area Output File: Specify an optional end-area (.EW) file for output that can be used in the Edit-Process End Area File command.

Prompts

Section File (Existing Ground) to Read choose existing .SCT file
Section File (Final Ground) to Read choose the other existing .SCT file
Calculate Sections Volume dialog Make selections.

Pulldown Menu Location: Sections
Keyboard Command: calcsct
Prerequisite: Two section (.SCT) files

Calculate End Area

This command allows the user to select two polylines representing an existing grade section and a final grade section, and calculate the end area. Or you can also specify and define cut/fill end areas by picking interior points. The area calculated can be drawn at a user specified point. Optionally, the command writes the stations cut and fill to an earthwork (.EW) file that can be printed/displayed by the Edit-Process End Area File command. This command starts with the Calculate End Area dialog.

Horizontal Scale: Specify the horizontal scale of the existing cross section.
Vertical Scale: Specify the vertical scale of the existing cross section.
Station Interval: Only available if Write Results to EW File is toggled on. Allows you to specify the station interval that the station prompting will default to as you select the polyline/sections for computation.
Extend Shorter Ends to Longer: Click or leave blank.
Calculate Unsuitable Areas: When checked, the user will be prompted for polyline(s) or interior point(s) that represent unsuitable material. The areas and/or volumes for the unsuitable material is reported out separately from the overall cut and fill areas and/or volumes for overexcavation consideration.
Define end areas by chooses between picking two polylines or picking inside each end area.
Text Scale: Specify the text size scaler, this value is multiplied by the horizontal scale to determine the final text height.
Decimal Places: Controls the decimals for the cut/fill area labels.
Cut/Fill Prefix/Suffix: Specify prefix and suffix for the cut, fill, and unsuitable labels.
Label Layer: Specify the layer for the cut/fill area labels.
Write Results to EW File: When checked, the results will be written to an earthwork (.EW) file. You may create a new file or choose to append/revise an existing file.

Prompts

Calculate End Area dialog make choices
Specify Earthworks File (ew) dialog specify new or existing file This box appears if Write Results to EW File is clicked.
Select existing grade polyline (ENTER to end): select polyline
Select final grade polyline: select polyline
Calculating End Area...
Cut: 12002.965 Fill: 660.272
Pick Point for Label (Enter for none): pick point

Enter the station <0.00> press Enter Pressing Enter selects the default station 0+00. If the station does not exist in the file it will be added. If it does it will be revised.
Select existing polyline: press Enter
Continue moving along automatically to the next station interval and select polylines. Or enter the station values randomly. The command sorts the .EW file regardless. As a result of this sort feature, the user can select stations in any order and they will be arranged in ascending order for proper volume computation.
Keyboard Command: endarea
Prerequisite: Plot the existing grade and final grade polyline/section

Edit Process End Area File
This command opens an End Area (.EW) file for editing and processing. Data can be entered directly into the spreadsheet. The Calculate Section Volumes command has an option to create an .EW file. The accumulative volume is displayed in the right side column of the spreadsheet. The Report function outputs a report of the stations, intervals, cut and fill. The Make Mass Haul Diagram function makes a .MAS file that can be used by the Draw Mass Diagram and Mass Diagram Report commands. The Use Centerline for Station Equations option applies to
end area data with stations numbered using station equations. This option will use the station equations defined in a centerline file to remove the station equations from the end area stations for calculating the true distances for the volume calculations. You will be prompted to select the centerline file.

### Pulldown Menu Location
Sections

### Keyboard Command
`ewedit`

### Prerequisite
None

## Roads Menu

### Design Template

This command creates a template definition file (.TPL file). The template file can then be applied in the *Process Road Design, Road Network, Draw Typical Template, Locate Template Points or Design Pad Template* commands. The template is designed using the dialog shown below. The top portion shows a graphic preview of the template as you create it. You can choose whether to show cut or fill slopes on the left and right sides. Also, you can choose whether to show the template in superelevation. In the middle is a row of icons which are the building blocks of the template. They can be chosen in any order by picking on the icon. In the bottom of the dialog are four list boxes that list the elements of the template. The surface elements are listed in order starting from the center. The subgrades are listed from top to bottom order. To add a template element, highlight the position in the list above where to insert the element. Then pick one of the element icons. To change the order of an element, highlight the element and pick the Move Up or Move Down buttons. The Edit button edits the dimensions of the highlighted element. The Remove button erases the highlighted element from the list. The Report button has two different report formats that include just the ID's of the template elements or all the dimensions of the template elements. The Change Units button allows you to apply a scale factor to the distances in the template which can be used to convert between English and Metric.

There is no limit to the number of surface or subgrade elements. Note that there is a Right Side Same as Left option. When active this option only requires template design for the left side and will automatically mirror the design for the right side.
The template surface can be composed of three types of elements: medians, grades and curbs. The median is a flexible closed figure defined in a clockwise direction. Each median point consists of an X and Y offset. The median must be closed and the program will automatically create the closing segment. In the Median Design dialog, the median is shown in the top display and bottom has a list of median points. The display shows the median in magenta and the grade lines in and out in green. For the display the grade in comes from the left and the grade out goes to the right. The median must define the Grade In point which is the point that ties into the incoming surface grade. Also the Grade Out point must be specified for where the surface grade continues out from the median. These Grade In and Grade Out points emanate from the starting or "from" position in the coordinate dialog where they are specified. Since a single median must be placed on the left or right side (and is typically not used symmetrically with right side same as left), you will need to offset the template centerline one-half the median width within the command Process Road Design in order to center the median. You will also have to move the "C/L" designation, to obtain centering, when using Draw Typical Template.
Using the Load and Save buttons, medians can be saved and loaded with .MDN files for sharing and re-use in other templates. The Up and Down buttons change the order of the highlighted X/Y Offset record in the list. The Pick button prompts to pick a closed polyline from the drawing to define the median geometry. The Set button shows a list of grade ID’s from the current Template ID Library. The Skip Median option creates the median only in the station range of Template Point Profile or Template Point Centerline transitions.

To enter the dimensions of the median, use the Add or Edit button. The adjustment factors control how to apply Template Point Profile and Template Point Centerline adjustments. For Template Point Profiles, the program figures the amount of vertical adjustment between the transition profile and the normal profile. The amount of this vertical adjustment is multiplied by the adjustment factor and then added to the X/Y Offsets of the median point. Likewise, the program figures the horizontal adjustment between the transition centerline and normal centerline for Template Point Centerlines and applies this adjustment by the factors to the offsets. These adjustment factors allow for dynamic medians. For example, the height of a retaining wall could be controlled using a Template Point Profile and the median points for the vertical sides would have a Y Factor set to 1 to pick up the full vertical adjustment and the median points for the top and bottom edges would have a Y Factor of 0 keep those edges the same.
You can design a median for "mirroring" to create a centered effect, as shown below. The only negative to this method is the appearance of a vertical line in the median plot.

Surface grades can be entered by selecting the Grades icon which brings up the dialog shown. Downhill slopes are negative and the Distance is the horizontal distance. The slope can be specified in either Percent, Ratio or Vertical format. The Vertical format is the actual elevation difference. The slope type can be either Liner or Parabolic. The Linear is a constant slope and the Parabolic gets steeper across the grade until it reaches the full specified slope at the end of the grade. The text ID serves 4 purposes: (1) The ID will be applied as a description to all final template points generated in the form of a coordinate (.CRD) file, (2) The ID can be used as a design point, as in EP+5 indicating 5 feet or meters right of edge of pavement, (3) Points of common ID may be connected by 3D polylines as an output option of Process Road Design and (4) Quantities can be generated with reference to the ID and material (gravel, concrete, etc.) entered elsewhere within this command. The Pick button prompts to select a linework segment or two points from the drawing to define the grade slope and distance. The Set button shows a list of grade ID's from

Chapter 6. Civil Module  

1467
To add a curb, select the Curb icon. The dialog box below appears where you can fill in the curb dimensions. There are three curb types to choose from. The curb dimensions can be specified in feet, inches or meters in metric mode. The Smooth option will smooth the surface of the curb which only shows when the template is applied in commands such as Process Road Design. The Round option will fillet a curve at the bottom and top of the taper using the specified Bottom and Top Radius. The Integral/Separate option determines whether to draw the front line of the curb to separate the curb from the subgrade. For example, fully concrete pavements that contain a curb would be drawn with the “integral” curb option. The Base Slope Type of the curb can either be flat, set to the slope of the incoming grade or set to a user-specified slope. For the Match Crown method, you can use the Table option to define a lookup table of different curb slopes for different crown grades. For cases with part of the curb at a slope and part flat, you can use the Base Break Offset to set the transition position between sloped and flat. The Target setting for the slope controls which parts of the curb are sloped. The Material name is used in the Process Road Design report. The ID is a unique identifier for this element of the template and is used for referencing the curb in other routines. The Direction controls which way the curb faces. This Direction option is needed for divided roads that have curbs facing both ways on either side of the road.
To specify cut treatment, pick the Cut icon. There is room to specify up to five cut slopes which can be slopes in series or slopes to use at different depths. In a simple case of one cut slope, you can just enter the one slope value and leave the depth and other slope boxes blank. For Slopes in Series, each slope is used up to the specified depth until an intersection with the ground. If the intersection is not reached by the first slope, then the next slope continues from where the first ended. If you have more than five slopes, pick the Repeat Slopes option which will repeat the sequence of entered slopes until the ground is reached. The Bench Between Cuts option allows you to enter a bench width and percent slope to be inserted between each cut slope. Besides running the cut slopes to specific depths, the Cut To Section option can be used to have each cut slope intersect a surface from a section (.sct) file. With Cut To Section on, the Process Road Design command will prompt for these cut slope section files. For example, this Cut To Section option could be used when you have a cut bench that occurs at a set elevation but different cut depths as the road profile changes. In this case, you could create a section (.sct) file at this set bench elevation.

The Pick buttons prompts to select a linework segment or two points from the drawing to define the cut slope.
The Tie to Set Offset forces the cut slope catch point to a specified fixed offset. This offset can be relative to the centerline or the template pivot point. This tie method can be used when you want the cut slope to always tie into existing at a fixed ROW offset.

The Force Fill option will make the template attempt to find a catch point with a fill slope even when the pivot point is in cut. You can specify the fill slope to use and the maximum depth for the fill slope.

The Tie ID sets the description to use in the design section file for the tie point. This is the same setting as under the Fill Grades dialog.

The Load Ditch and Save Ditch functions allow you to save and recall ditch grades to a .DIT file. This way to can make your own library of ditch definitions.

With Slopes in Series off, just one of the slopes is used depending on the depth. For example, set the dialog as shown to use 4 to 1 slopes at depths up to 4 feet, 3:1 up to 10 and 2:1 if deeper. The effect is 4:1 if shallow and, by contrast, 2:1 if the fill is deep. The Smooth Transitions option will gradually transition the slopes from one range to the next. In this example, if the depth is 5 feet the slope will be between 4:1 and 3:1. The graphic in the Design Template dialog will explicitly show slopes in series versus individual slope depending on setting (shown below are individual slopes, with slopes in series off):

![Diagram of slopes in series]

The Pivot at Subgrade option will position the cut pivot point where the bottom subgrade intersects the template grade. The ditch or upslope conditions will then occur from this special subgrade "daylight" pivot point, instead of from the outer shoulder surface pivot point. The Tie to Existing Point will draw the cut slope from the cut pivot point to either the outside offset-elevation or an offset-elevation point with a specified description from the existing section file. This method is used when survey crews take sections and designate the specific slope tie points.

![Diagram of pivot at subgrade]

The Slope to Rock applies in Process Road Design when using a Rock Section File. There are two slope order modes for rock slopes: Slope TO Rock and Slope FROM Rock. For the Slope TO Rock mode, the cut slope will be the Slope To Rock up to the rock surface. After reaching the rock surface, the regular cut slopes apply. For the Slope FROM Rock mode, the regular cut slopes apply up to the rock surface. Then from the Slope From Rock applies from the rock surface to the ground surface.

![Diagram of slopes to rock]
Ditch Grades can be inserted prior to the application of the cut upslope. For curb and gutter roads, there is typically no ditch. But for roads with drainage downhill to the outside and no curbs, ditches are typically used in cut conditions. The Ditch Grades list contains each ditch grade in order from the regular template. Any number of ditch grades can be added by picking the Add Ditch button. To create a V ditch, add just one ditch grade such as slope ratio -1, distance 1. This makes one side of the V. The pivot point for the cut slopes will be the bottom of the V and the other side of the V will be made by the cut upslopes. For a ditch with a flat bottom, you could have two ditch grades such as slope ratio -2, distance 4 and then slope percent 0, distance 2. If a minimum depth for ditch is entered, no ditch will be applied unless the cut exceeds that depth. The Force Berm will apply the Berm (defined using the Fill icon) in cut instead of a ditch up to a certain depth of cut.

Fill treatment is similar to cut. Up to five slopes for different depths can be specified. Slopes in Series and Smooth Transitions work the same way as cut. Berm Grades are the fill equivalent to Ditch Grades. Fill treatment does have some extra options. Guardrail Expansion will extend the last template surface grade the specified Shoulder Distance when the fill is greater than the Min Depth. The Force Ditch option has two different methods to apply the Ditch Grades from the cut definition. With "At Base Of Fill" on, Force Ditch creates the ditch where the fill slope hits existing ground. With "At Base of Fill" off, the Force Ditch method applies the ditch grades from the template pivot point. The Minimum Depth for Berm Grades will only draw the Berm Grades when the fill depth is greater than the specified value. The Force Cut option will make the template attempt to find a catch point with a cut slope even when the pivot point is in fill. You can specify the cut slope to use and the maximum depth for the cut slope.
The Right of Way icon brings up the dialog shown which allows you to specify whether to use a retaining wall to keep the cut/fill slopes from crossing the right of way. The right of way data is stored in a centerline file (.cl file) as stations and offsets for the left and right sides of a centerline. When the retaining wall option is active, the cut or fill slope will go at the design slope up to the right of way and then the slope will tie into the ground by going straight up or down. Without the retaining wall option, the cut or fill slope will become steeper in order to tie into the ground at the right of way. For example, if the cut slope is 50% but this slope ties into the ground past the right of way, then the slope will be modified to something steeper such as 65%. The Offset ROW options will force the tie in the offset distance before the right of way.

The Shoulder Super Elevation icon specifies where on the template the slopes will transition between super elevation slopes and normal slopes. The transition point is identified under Pivot Point by the template id for the grade, curb or median. Note that the pivot point can be specified as an ID plus a distance as in "EP+2". Starting from the center, the template grades will be in super up through this template segment. For example, based on the template shown in the first dialog of this command, the EOP Pivot Point the Super Elevation Settings dialog will create the first EOP grade in super while the curb and grade S will be at normal grade. The High and Low Pivot Point options allow for different transition points depending on which side is raised by the super elevation. The Max Percent Slope Difference is the maximum difference between the super elevation grade and the normal grade at the pivot point. For example with a Max Percent Slope Difference of 7%, if the super elevation grade is 6%, then the slope after the pivot on the high side will be -1% even if the normal design slope is steeper than -1%. If the grades do not start from the center in super, then the Divided Roads option can be used. With this option, the grades start from the center as normal and then transition to super at the Normal to Super Pivot Point.

Here is an example of super elevation of 4% to the right for a divided road with a Max Difference of 7%. The
normal template is shown above. The Normal to Super Pivot Point is MED and the Super to Normal Pivot Point is EP. The result is that the EP segment is in super and the SH and MED segments are at normal slope. On the left, the SH segment is at the normal -10%, the EP segment is at the super elevation slope of -4% and the MED segment wants to be at 4% but ends up at 3% because this meets the Max Difference requirement. On the right side, the MED segment starts at the normal -4%, then the EP segment transitions into the super -4% and then the SH transitions back to normal which results in a 3% slope because of the Max Difference requirement.

The Low Side Grades To Match Greater Super Slope option applies to the template grades that are outside the super pivot. When the super slope becomes steeper than these outside grades, then these grades are adjusted to match the same super slope. You can set up to two grades past the super pivot to adjust. For example, consider a template where the super pivot is the EP grade and the next grade is a SHD for the shoulder. If the SHD normal slope is -4%, then the SHD will stay at -4% through the super transition until the super becomes greater that -4%. So when the super is at -6%, the SHD will also be at -6%.

The Pivot Super From Low Edge holds the normal crown grade of the low side edge of super and raises the rest of the template to match the super slopes. Otherwise the profile grade at the centerline is held.

To add subgrades click the SubGrades icon which brings up the dialog shown. The subgrades are areas below the template surface. There can be any number of subgrades stacked one below another or side by side.

The subgrade starts from the surface at the distance from the center set under Horizontal Offset. To start from the centerline, enter 0 in Horizontal Offset. First the subgrade moves straight down from this Horizontal Offset. The depth down is specified in Vertical Offset in feet units or meters in metric mode. The Vertical Offset normally should be set as a negative number. The bottom of the subgrade then either moves away from or towards the center depending in the Direction In or Out setting. The distance to move is specified under Distance. The Slope Type for

![Sub-Grade Dimensions dialog](image)

To add subgrades click the SubGrades icon which brings up the dialog shown. The subgrades are areas below the template surface. There can be any number of subgrades stacked one below another or side by side.

The subgrade starts from the surface at the distance from the center set under Horizontal Offset. To start from the centerline, enter 0 in Horizontal Offset. First the subgrade moves straight down from this Horizontal Offset. The depth down is specified in Vertical Offset in feet units or meters in metric mode. The Vertical Offset normally should be set as a negative number. The bottom of the subgrade then either moves away from or towards the center depending in the Direction In or Out setting. The distance to move is specified under Distance. The Slope Type for
the subgrade bottom can be either set to a specified slope or set to match the grades of the surface. After moving
the specified distance, the subgrade will tie back into the template surface either by going straight up, by continuing
at the subgrade slope until intersecting the surface or by wrapping around. The commonly used "continue slope"
approach will extend the slope until it hits something (like a curb or another surface segment). It will not trim. So
if the pavement segment is 12 feet to a curb, it is better to enter 10 and "continue slope" than to enter 12 exactly,
as a "tilted" curb may place the curb edge at 11.98' from the start of the subgrade, causing the subgrade to go past
face of curb and intersect back of curb. Also, for angled tie-ins of subgrade from base of curb to the surface, such
as the example shown below, be sure the distance entered is less than what would intersect the surface, so that the
"extend" effect will create the intersect. In this example, the first subgrade (asphalt) is "continue slope", the second
(gravel) is "straight up" and the third (gravel tie in behind curb) is "continue slope".

The Material field is an optional description that is used in the Process Road Design report.

Special super elevation pivot points may optionally be specified. The Pivot Offset allows the subgrade slope to
break in super elevation independently of where the surface grade breaks. The subgrade will follow the super
elevation slope from the centerline to the Pivot Offset. Then after the Pivot Offset, there are options to set the slope.
The Min and Max Slope settings restrict the subgrade slope. The Normal option sets the slope the same as the
non-super elevation state. The Special option can be used to set the slope to a specific value.

The Subgrade values for Horizontal Offset, Distance and Pivot Offset can be specified by template ID. For example,
EP could be used in Distance to have the subgrade have a width of the EP grade. Also expressions can be used such
as EP+5 to go the distance of the EP segment plus 5. This is especially useful for template transitions so that if the
EP grade varies the subgrade width will automatically adjust.
Example of Wrap Around Subgrade

Pulldown Menu Location: Roads
Keyboard Command: template
Prerequisite: None

**Draw Typical Template**

This command draws a template and labels the slopes and distances. The cut and fill treatment can be shown on the left and/or right sides. All the cut/fill slopes are shown for the different depths when multiple slopes are defined. There are options to draw the normal template, super elevation or details of different sections.

You will be prompted to select the template (.TPL) file first, then the Typical Section dialog appears. Specify the parameters and press the Draw button.
Prompts

**Template File to Read** Specify a template file.
**Typical Section dialog** Set your options then click Draw.
**Pick Starting Position:** *pick a point*

Curb Detail

Normal Typical Template
Typical Template with Left Super Elevation

**Pulldown Menu Location:** Roads  
**Keyboard Command:** typical  
**Prerequisite:** A template file (.TPL file)

## Template Transition

This command creates a template transition file (.TPT file) that can be used for the commands *Locate Template Points* and *Process Road Design*. The template transition is associated with a typical template (.TPL) file. The template transition file defines changes in grade distances or slopes for a specific template ID through a specified range of stations. Lane widths, for example, can be made to expand and contract. You can only modify existing template grades. Template Transition does not allow curbs, medians, subgrades or cut/fill treatment to be modified. Also new template elements cannot be added and existing elements cannot be removed. For this reason, lanes of road that "emerge" and slope distinctly from standard road lanes would need to be entered as small (0.001 in width) segments in the original template, available for expansion using Template Transition. Template Transition offers one of 3 ways to change template widths and slopes. Another way involves use of Template Point Profile and Template Point Centerline, where a particular template ID can be directed to follow a specific profile and centerline of its own. The third method is template-to-template transitions using Input-Edit Template Series, where distinct templates transition one to another. All three methods require that template IDs "pre-exist" in order to be expanded, or to follow profiles and centerlines, or to transition between template files. So the technique of making very short phantom segments for emerging and disappearing "lanes" or roads with distinct grades is universal. If special slopes are not involved, lanes can expand and contract without creation of phantom segments in the original template. Only clever use of Input-Edit Template Series, where templates with no curbs could "end" and templates with curbs can begin at specified stations, can effectively make "new" features like curbs and medians materialize.
Reviewing the below plan view, when you are given stations and offsets that define a template position like edge-of-pavement (above), you can use Template Transition effectively.
The first Template Transition dialog shows a list of the transitions, covering the above right-lane variable width. To add a transition, click the Add button. This brings up the second Template Transition dialog which shows the transition template for the second segment. The middle sections list the template grades that can be changed. To modify a grade, highlight the grade and click the Edit button. The Report function creates a report of the template transition data.

The Begin Transition Station is where the normal template begins to transition to the modified template. The Begin Full Template Station is where the modified template is used entirely. The End Full Template Station is where the template starts to transition back to normal. The End Transition Station is where the template has returned to normal. This method is designed for elements like passing lanes which expand from normal then contract back to normal. But you can also use this method for roads that start off or end expanded or altered. For example, to start off the road at a 40' edge-of-pavement dimension, it is necessary to transition up from 12.5' (normal dimension). If you need to have 40' at station 0, then enter station -0.01 as the "Begin Transition Station", and enter station 0 as the "Begin Full Template Station". Select the EP grade in the dialog, and change it to 40'. Then click "Link to next transition". The Link to Next Transition option joins the current transition to the next transition without returning to the normal template. This takes you to the second dialog, shown above. You sustain the 40' width from Begin Transition Station 125.29 and transition at station 215.08 to a 24.23' dimension. Then quickly end the transition at station 215.081 for the "End Full Template Station". Finally, transition back to normal 12.5' by entering 335.51 for "End Transition Station".

The Series # setting is for grouping a sequence of transitions separately from other transitions. This Series # allows for independent transitions over the same station range. All transition changes that are part of the same transition should be given the same Series #. For example, when a grade on the right side of the road transitions separately from a grade on the left side of the road, all the transitions for the right side grade could be assigned as Series #1 and all transitions for the left side grade could be assigned as Series #2.

There is another "trick" to using Template Transition with templates that include subgrades. The subgrades will not automatically extend and follow the expanded grade IDs such as EP for "edge-of-pavemen", unless the subgrades are defined in terms of the IDs themselves within Design Template. Subgrades that expand "at slope" to intersect a curb, for example, can expand naturally as the curb position moves outward on the right side. But subgrades that go "straight up" at back of curb at offset 14.5' in this example will stay at 14.5', unless defined as shown below by referencing the "EP ID:

![Sub-Grade Dimensions](image-url)

Cut and Fill slopes can also be transitioned by picking the Cut and Fill buttons. Ditch and Berm grades can also be modified here.
Transitions can also be applied to the left, right or both sides. This allows you to have separate overlapping transitions for the left and right sides.

**Prompts**

**Template Transition to Edit/Create** Choose New to create a transition file or Edit to modify a transition file

**Template File to Edit:** Specify a transition file

**Template Transition dialog**

**Pulldown Menu Location:** Roads

**Keyboard Command:** tpltrans

**Prerequisite:** A template .TPT file

---

**Template Grade Table**

This command creates a Template Grade Table file (.TGT), which is a lookup file for slopes and distances at stations for grade points within a template. Each side of the template is controlled independently. This user interface provides a simple and easy way to handle complex transitions. A similar result could be produced using a Template Series, or a combination of Template Grade Centerline for horizontal control and Template Grade Profile for vertical control. The advantage of Template Grade Table is that it provides a simpler solution. Besides handling transitions like lane widening, it can also be used to specify superelevation control.

A Template Grade Table can be used on a single road with Process Road Design command, or specified for specific roads within a Road Network.

The Template Grade Table is associated with an existing typical template (.TPL) file.

The Match Slope function assigns slopes to the grade table using cross slopes from a reference section file. This function can be used to match the template slopes to existing slopes such as for road rehabilitation to match the new road cross slopes to the existing. After selecting the reference section file, there is a dialog to set the range of stations to process and the offsets of the sections to get the cross slope from. The second offset is optional. When only one offset is specified, the program uses the existing slope at the offset. When both offsets are set, the slope is calculated between the two offset points on the existing surface. The Lowest and Highest Slope % settings are optional restrictions on the transition slopes. The Low/High Slope range can also be set by entering the Target Slope and Slope Tolerance. The Use Reference Template Grade Table for Target Slope option is a method to match the slope within the Slope Tolerance to a variable slope. For example, this option applies when matching an existing
road that is transitioning through superelevation. When active, this option will make the program prompt for a separate Template Grade Table to use for the slope reference. The Max Slope Rate of Change Per 100 is an optional restriction on how quickly the slopes can change between stations. If you don't want to use a restriction, you can leave the field blank or set a high value.

The Report function shows all of the slope and distance changes for all of the template grades.

The Import function reads in transition data to the currently highlighted grade in the list. The data can come from either a text file, drawing graphics or superelevation file. For the text file, the format should have station, slope% and distance separated by a delimiter such as a comma. For the drawing graphics, the import reads a polyline on a superelevation diagram grid to set the transition slopes. For superelevation file method, the import reads the transition slopes from a .sup file.

**Prompts**

**Template Grade Table to Edit/Create** Choose New to create a new Template Grade Table, or Edit to modify an existing one.

**Template File to Process:** When creating a new Template Grade Table, an existing Template file must be selected to be used with it. When editing an existing .TGT, the Template previously associated with it will be automatically loaded with it.

**Template Grade Table dialog**
**Pulldown Menu Location:** Roads  
**Keyboard Command:** tpltable  
**Prerequisite:** A template .TPL file

---

**Input-Edit Super Elevation**

This command is an editor for super elevation stationing. The super elevation data is stored in new or existing super elevation (.SUP) files. When creating a new super elevation file, there is an option to read a centerline file and build the super elevation stationing based on the curves and spirals in the centerline using AASHTO-based stationing or optionally, the Virginia DOT method. The AASHTO calculations are based on the equations in chapter 3 of the 2004 Green Book titled Geometric Design of Highway and Streets. The length of the transition from normal crown to superelevation will be automatically computed by the program using either method based on the design speed and other settings, but the user can control what percentage of this transition to and from superelevation occurs in the tangent leading up to the curve or in the curve itself. The Use Transition Curves option enables fields for the transition curves at each super elevation grade break. For example, if a normal grade is -2% and it starts changing at station 1+00 to reach 4% as station 2+00, then you could have a transition at 1+00 to go from the constant -2% to the rate of change of 6% over 100'. This transition curve will show up in the Draw Superelevation Diagram similar to a vertical curve in Draw Profile.
The main superelevation dialog displays a list of each super elevation transition. These entries should be sequentially entered from lowest to highest stations. To edit the super elevation stationing, highlight the entry line and click Edit. The Add button creates a new entry below the current highlighted row or at the top of the list if no row is highlighted. The Delete button removes the highlighted row from the list. The Save button saves the super elevation file. To exit the program without saving, click the Cancel button.

The super elevation stationing is entered in the Input/Edit Superelevation dialog. The View Table button shows a table of the super elevation slope for the delta angle and radius at different design speeds. The Calc Super button calculates the slope of full super given the design speed. The station entries are defined as follows:
**Station to begin transition:** where normal crown rate begins to transition

**Station to begin super run-in:** where slope becomes flat

**Station for super at normal crown rate in:** where slope equals negative of normal crown rate

**Station to begin full super:** where slope reaches full super slope

**Station to end full super:** where slopes begins to transition from full super back to normal

**Station for super at normal crown rate out:** where slope equals negative of normal crown rate

**Station to end super runoff:** where slope becomes flat

**Station to end transition:** where slope returns to normal crown rate

Given these various Station settings, an unequal rate of change can occur between any two stations. However, the program can calculate the stations to set an even rate of transition, as long as it knows the max superelevation, the normal crown slope and the station to start transition, start full super, end full super and end transition. The Calculate Stations button therefore calculates the stations for begin run-in, normal crown rate in, normal crown rate out and end super runoff. To calculate these stations the values with an "*" must be entered.

The Compound Curve option allows you to specify a second superelevation slope for a compound curve. In addition to specifying the second slope, the starting and ending stations for this slope must also be entered. The Reverse Curve option is similar to the Compound Curve option. A typical Reverse Curve is shown below in plan view and as it would appear in the summary dialog:
Station 399+00 is the "pivot" where superelevation left flattens and turns into superelevation right.

**Prompts**

**New or Existing Super Elevation File dialog**
**Superelevation File to Process** Specify a superelevation file.

**Superelevation Editor dialog**

**Pulldown Menu Location:** Roads
**Keyboard Command:** super
**Prerequisite:** None
**Draw Super Elevation Diagram**

This command allows the user to draw the contents of a Super Elevation Diagram (.SUD) file after it has been created through the Process Road Design or the Road Network commands.

The Super Elevation Diagram is a graphical representation of the change in cross-slope between the centerline and the left and right shoulders of a roadway. The diagram is typically drawn on a grid, similar to a profile, where the horizontal component represents the stationing of the roadway and the vertical component shows the cross-slope.

![Super Elevation Diagram](image)

**Super Elevation Diagram**

**Draw Super Elevation Diagram Dialog Box**

**Select:** Use this button (at the top-left of the dialog) to browse to and select the Super Elevation Diagram file (.sud) to be drawn.

**Edge Code to Draw:** Use this dropdown box to select the Template ID to be represented in the Super Elevation Diagram.

**Link Diagram to File:** This setting has 3 options: **Off**, **Prompt** and **Auto**:

- **Off:** This option will not re-draw the Diagram in the drawing if and when the Super Elevation Diagram (.SUD) file...
changes.

**Prompt:** This option will notify the user that the Super Elevation Diagram (.SUD) file has changed and give the option of re-drawing the Diagram in the drawing.

**Auto:** This option automatically re-draws the Diagram when the Super Elevation Diagram (.SUD) file changes.

**Ref CL:** Use the **Select** button to associate the Super Elevation Diagram (.SUD) file with a Centerline (.CL) file.

After the (.SUD) file has been selected, various details about the file such as "Slope Range", "Station Range" and "Total Length" are displayed below the **Ref CL:** setting.

### Plot Settings

**Horizontal Scale:** Set as needed.

**Vertical Scale:** Set as needed.

**Station Range to Draw:** Enter "ALL" to draw the entire length of roadway or specify a range of stations.

**Max Length/Diagram:** Specify the maximum length of each diagram. If the "Station Range to Draw" is longer than the "Max Length/Diagram", additional diagrams will be stacked vertically above the first.

**Space Between Grids:** If the total length of the Diagram requires stacking of multiple Diagrams, this value specifies the distance between Diagram Grids.

**Maximum Diagrams per Column:** When multiple Diagrams are stacked, this number sets the maximum number of Diagrams per Column. If this number is reached, a second column will be created.

### Grid Settings

**Plot Grid:** Select this option to have centerline and shoulder diagrams drawn on a grid.

**Style:** Select the Grid Style from several options. **Grid Lines** is the default setting. Other options are:

- **Ticks Only:** This setting draws tick marks for both the station increments along the bottom and the slope increments along the left edge of the diagram.
- **Ticks and Dots:** This setting draws tick marks for both the station increments along the bottom and the slope increments along the left edge of the diagram and draws a series of "dots" in a grid pattern across the rest of the diagram.
- **Ticks and Checks:** This setting draws tick marks for both the station increments along the bottom and the slope increments along the left edge of the diagram and draws a series of "+"-signs in a grid pattern across the rest of the diagram.

**Grid Spacing:** Set Vertical and Horizontal Grid Spacing as needed.

**Layer:** Enter the name of the Layer for grid lines, ticks, dots and checks or use the **[button]** to select the Layer from a list.

**Color:** Enter the Color for grid lines, ticks, dots and checks or use the **[button]** to select the Color from a list.

**Draw Grid Text:** Select this option to draw Grid Text for stationing and cross-slopes. Use the **[button]** to specify Grid Text settings such as precision, text size scaler, layer, text style, color and vertical/horizontal spacing.

### Left Shoulder & Right Shoulder Settings

**Layer:** Enter the name of the Layer for the Left or Right Shoulder or use the **[button]** to select the Layer from a list.

**Color:** Enter the Color for the Left or Right Shoulder or use the **[button]** to select the Color from a list.

**Linetype:** Enter the Linetype for the Left or Right Shoulder or use the **[button]** to select the Linetype from a list.

**Label Stations:** Select this option to label the Station value at each slope change along the Left or Right Shoulder. Use the **[button]** to specify Shoulder Station Label settings such as precision, text size scaler, layer, text style,
Left & Right Shoulder: Station Label Settings

Label Slopes: Select this option to label the Slopes along the Left or Right Shoulder. Use the button to specify Shoulder Slope Label settings such as precision, text size scaler, layer, text style, color and prefix or suffix. The user also has the option of positioning the Slope label at the station of the Slope change or along the transition line.

Center Line Settings

Layer: Enter the name of the Layer for the Centerline or use the button to select the Layer from a list.  
Color: Enter the Color for the Centerline or use the button to select the Color from a list.  
Linetype: Enter the Linetype for the Centerline or use the button to select the Linetype from a list.

Station and Slope Type Settings

Station Type: Select the desired format for Station. The options are: Percent or Ft/Ft.  
Slope Type: Select the desired format for Slope. The options are: 1+00, 1+000 or 100.

Other Labels
**Draw Transition Points:** Enable this option and use the button to configure and format the labels for Transition Start, Start Curve, End of Curve and End of Transition.

![Label Transition Points Dialog Box]

**Label Transition Points Dialog Box**

**Draw Axis of Rotation:** Enable this option and use the button to configure and format the labels for the Axis of Rotation. The Axis of Rotation is a small icon displayed at the bottom of the grid at critical Super Elevation Points. The icon shows a cross-section view of the pavement slopes and a "+"-sign indicating the point of rotation for the Super Elevation.

![Axis of Rotation]

**Axis of Rotation**

![Label Axis of Rotation Dialog Box]

**Label Axis of Rotation Dialog Box**
**Draw Non-Linear Transition Points**: Non-linear transition points are drawn when the rate of change of elevation is not constant at the point where the Super Elevation starts or ends. Enable this option and use the button to configure and format the labels for *Start of Curve, End of Curve* and *Point of Intersection*.

![Label Non-Linear Transition Points](image1)

**Label Non-Linear Transition Points**

**Label Centerline Curve/Spiral Stations**: Enable this option and use the button to configure and format the labels for *Point of Curve, Point of Tangent, Tangent to Spiral, Spiral to Curve, Curve to Spiral, Spiral to Tangent* and *Spiral Only*.

![Label Centerline Curve/Spiral Stations](image2)
**Label Runoff Lengths**: Enable this option and use the button to configure and format the labels for *Tangent Runout, Super Elevation Runoff* and *Full Super*. These distances are displayed as linear dimensions above the Diagram Grid.

**Pulldown Menu Location(s)**: Civil > Roads  
**Keyboard Command**: drawsud  
**Prerequisite**: Super Elevation Diagram file (.sud)

### Input-Edit Template Series

Template Series is another method of widening lanes or causing templates to change: direct template-to-template transitioning. Using this command, you specify the station where one template "ends" and the station where another template "begins", and the program auto-transitions between templates.

The Template Series is stored in a .TSF file and consists of a sequence of template file names (.TPL) with stationing. The Design Template command is used to create the .TPL files. The Template Series can be used in commands like Process Road Design and Road Network. In these commands, the template selection can be either a regular template (.TPL) or the template series (.TSF).

For the transition to work optimally, the templates should share the same IDs so that the program can connect the template 3D polylines and transition between templates. If the templates are distinct with separate, unrelated IDs, then by ending template1 at station 500 (for example) and starting template2 at station 500.01, a very abrupt transition can be accomplished.

For a design with transitioning templates, the Template Series method is an alternative to the Template Transition method, a third method of Template Grade Table, and to a forth method of using Template Point Profiles and Template Point Centerlines, where a template ID "follows" a particular centerline and profile. One advantage of the Template Series approach is that it can be used to link different templates together, like non-curb and curb templates, as shown here in plan view:
For the above example, Template 1 applies from station 0+00 to 0+30, then transitions to Template 2 at 1+00 which has a wider EOP distance. This transition occurs between stations 0+30 and 1+00. Then the full Template 2 continues until station 1+40. Then Template 3 starts with a curb replacing a standard EOP/Ditch combination on the left side. So Template 3 would be set to begin at 1+40.1, a short distance past 1+40. This template transitions into Template 4 at station 2+00. Template 4 has a shorter middle grade on the left side. You do not need to enter start and ending templates at station 0+00 or after station 2+00. Therefore, the dialog for this example might look as follows:

Note that you can run Process Road Design to review the design results in plan view, with entry of only the Design Template/Series, the Profile and the Centerline (items 1, 2 and 4 within Process Road Design). You do not need existing cross sections to use Process Road Design. If you process at an interval such as 10 over any desired station range, you can output the Template Polylines and verify the result in plan view. If no sections are found, the program will process from edge of shoulder left to edge of shoulder right, and omit cut and fill slopes. With the correct templates, this would reproduce the plan view shown above.

Input-Edit Template Series is also an effective way to accomplish superelevation, and even simultaneous superelevation and lane widening. Consider the "stages" of pivoting into superelevation of 3%. The first template might be called "Normal Crown" (the lower template). The second template might be called "Reverse Crown" (+2% cross slope). The third template might be called "Full Super" and would be the +3% template. You need the second template because you need to "restrain" the left-hand side of the road from pivoting until the continuous +2% cross slope is reached. If you only used the "Normal Crown" template, say, at station 4+00 and then the "Full Super" template at station 6+00, then at station 5+00, where 1/2 of the transition occurs, the left side cross slope would be -2.5% (transitioning halfway). In reality, the left side should not pivot until station 5+60. If the rate of pivoting is less from normal crown to flat outside lane, and the rate changes after that point, then you would need a fourth template to direct how the road transitions to full superelevation.

The Reference CL is optional. When it is set, then screen pick is an option for specifying the template transition stations.
The Report function has options for either a summary report of the stations and template, or a detailed report that adds the template dimensions.

The Reset Direction function applies when the folder for the template files (.TPL) has changed and you need to set a new location.

The Create From Sections function reads a section file for a design and creates templates at each change and fills in the template series with these templates. The section file must have descriptions on the section points (ie "EOP").

Here is the dialog for adding and editing templates for the series where you set the template name and station to apply. The Transition With Previous Template In Series will match any common template ID's with the previous template and linear interpolate any changes in distance or slope for the stations between the templates. Otherwise, the template dimensions are held unmodified up to the midway station between the templates where the switch occurs.

Pulldown Menu Location: Roads
Keyboard Command: tplseries
Prerequisite: Template Files

**Topsoil Removal/Replacement**

This command creates a topsoil definition (.TOP) file which defines topsoil removal and replacement zones to be used in the Process Road Design command. You can have different topsoil adjustments for different station ranges. These adjustments are applied to the existing ground section in the Process Road Design command and will effect the cut and fill volumes. Process Road Design will also report the amounts of topsoil removal and replacement.

The command starts by displaying a list of the topsoil stations in the dialog shown below. To add a topsoil adjustment, pick the Add button which brings up a second dialog. You can have different amounts of topsoil removal and replacement for areas in cut and areas in fill. Subsoil is another category of removal that will be combined with any topsoil removal. The Subsoil removal volume is reported separately from topsoil removal by Process Road Design. Subsoil is automatically removed from the site and not used in fill or as a replacement quantity. Therefore, the subsoil element applies only to unsuitable materials that need to be removed. In the example below, we are only removing topsoil in cut (where cutting must take place in any case), and in the cut, we are removing 2’ of subsoil which will be hauled off site (since subsoil is not re-used). The removed 0.5’ of topsoil in cut will then be replaced in both cut and fill zones of the road within the limits specified by the 'Replacement Limit ID'. (No topsoil will be replaced on paved surfaces!)
The Replacement Limit ID is an option to limit the replacement to occur only within the template left offset Limit ID and the right offset Limit ID. If this Limit ID is left blank, then the program will apply the replacement between the left catch point and the right catch point. Topsoil removal is always applied between the catch points. The Limit ID corresponds to a template ID as set in the Design Template routine. Typically, you would use an ID like SH for shoulder and replace topsoil only from the far left and right tie/catch points to the SH or shoulder point. If you use a curb and want to replace topsoil to back of curb, keep in mind that the program takes the basic code "CB" and creates 3 curb points typically, so the back of curb would become CB3 in most L-shaped curbs.

If the Topsoil (".TOP") file is selected within Process Road Design, all quantities of topsoil removal and replacement and subsoil removal are reported, as shown below:

Processing 0+00.00 to 4+42.10

Total Topsoil Removed: 5219.22 C.F., 193.30 C.Y.
Total Subsoil Removed: 20876.89 C.F., 773.22 C.Y.
Total Topsoil Replaced: 5309.57 C.F., 196.65 C.Y.
Hauled-In Topsoil: 90.35 C.F., 3.35 C.Y.
Total Cut: 9106.52 C.F., 337.28 C.Y.
Total Fill: 16402.56 C.F., 607.50 C.Y.
Total SUBGRADE1 - asphalt: 2763.36 C.F., 102.35 C.Y.
Total SUBGRADE2 - stone: 9209.44 C.F., 341.09 C.Y.
Total CURB - concrete: 1078.37 C.F., 39.94 C.Y.

The cut reported in Process Road Design would be the remaining cut after topsoil and subsoil removal, and the fill would be the fill necessary to bring the grade to base of topsoil replacement, on top of which the topsoil is added. The removal of topsoil and subsoil usually creates less cut and more fill, as some of the cut is accomplished by the topsoil/subsoil removal, and in terms of fill, the grade must be brought up to replace the "cavity" created by the topsoil and subsoil removal. Topsoil removal depths and replacement depths can have a dramatic impact on cut and fill quantities, particularly on smaller scale projects like subdivision roads. In this example, every extra 0.1' of topsoil removal produces approximately 100 c.y. of net fill.
Prompts

Topsoil File to Read Specify a topsoil file.
Topsoil dialog Choose your options.

Keyboard Command: topsoil
Prerequisite: None

Assign Template Point Profile

This command assigns profile (.PRO) files to template point ID's like EP (edge of pavement), SH (shoulder) or DL (ditch line), storing this information in a template point profile (.TPP) file which can be used by the Process Road Design and Road Network commands. The purpose of the profile assignments is to allow separate profiles for template points that are independent of the centerline profile. For example, a ditch grade could have a different profile than the centerline. Multiple template point profiles can be assigned so the amount of control is unlimited. The Template Point Description corresponds to the name set in the Design Template command.

If you want the template ID point to follow a special slope or vertical alignment, use Assign Template Point Profile. The combination of using template point centerlines and profiles applied to particular template ID points is a design method sometimes referred to as "strings", where template elements string along special horizontal and vertical alignments. The rules of the template in terms of distances and slopes to the next point in the template will resume after the template point centerline and profiles are applied.

Prompts

First you are prompted to create a new Template Point Profile (.TPP), or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Profile assignments. To add a new assignment, first pick the Set button to set the Reference Template file (.TPL), then pick the Add button. This brings up the Template Point Profile Settings dialog. First, pick a Template Point Description from the List, which is derived from the components defined in the Template. Next, pick the Specify Profile File button, to choose the file (.PRO) to assign to the Template Point ID. Alternatively, instead of picking a profile, you can use the Screen Pick button to select a 3D polyline from the drawing which the program will use to generate a profile. Next, enter the Station range to Apply the assignment, select the Station Reference, specify if this assignment is for the Left, Right, or both sides of the main centerline, and finally specify the method to apply the assignment. Since the template ID profile can change the relative position of the template ID from the centerline, you have two options for how to fit in the template ID profile: Hold Offset or Hold Slope. Hold Offset will keep the same offset for the template ID and adjust the slope to the template ID. The Hold Slope will keep the same slope to the template ID and adjust the offset to reach the template ID profile elevation. Use Hold Offset when Template Point Profile is used in conjunction with Template Point Centerline, where a single template ID is defined to follow both a special and distinct horizontal alignment (centerline) and vertical alignment (profile).

Pick OK. Back in the Define Template Alignments dialog, pick Add to add another assignment, Edit to edit an existing assignment, Report to create a report of the template point profile data, Delete to delete a defined assignment, or Save to Exit.
Now Process the road design employing the newly defined Template Point Profile assignment. In the Process Road Design main dialog, pick the Template Point Profile button to select the new file (.TPP). You could also create a new Template Point Profile file directly from this dialog box by picking the Edit button and specifying a new file name.

**Pulldown Menu Location:** Roads
**Keyboard Command:** tppset
**Prerequisite:** Profile file (.PRO) or 3D polyline

---

**Assign Template Point Centerline**

In roadway design situations involving varying pavement widths, the only effective way to control the edge of pavement positions is through the use of Assign Template Point Centerline. This command assigns centerline (.CL) files to template ID points, independent of the main centerline, thereby controlling the horizontal location of the edge of pavement. The assignment of Template ID points to centerline files (.CL) is stored in Template Point Centerline files (.TPC). These files are then used by the Process Road Design and Road Network commands. The slope to these template points is based on the parameters defined in Design Template. Subgrades can be made to follow template IDs if their offset distances are defined not by distance but by reference to the template ID.

---

**Prompts**
First you are prompted to create a new Template Point Centerline file (.TPC), or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Centerline assignments. To add a new assignment, first pick the Set button to set the Reference Template file (.TPL), then pick the Add button. This brings up the Template Point Centerline Settings dialog. First, pick a Template Point Description from the List, which is derived from the components defined in the Template. Next, pick the Specify Centerline File button, to choose the file (.CL) to assign to the Template Point ID. Alternatively, you can use the Screen Pick button to select a polyline from the drawing that the program will use to generate a centerline. Finally, specify if this assignment is for the Left or Right side of the main centerline. Pick OK. Back in the Define Template Alignments dialog, pick Add to add another assignment, Edit to edit an existing assignment, Delete to delete a defined assignment, Report to create a report of the template point centerline data, or Save to Exit.

Now Process the road design employing the newly defined Template Point Centerline assignment. In the Process Road Design main dialog, pick the Template Pt Centerline button to select the new file (.TPC). You could also create a new Template Point Centerline file directly from this dialog box using the Edit button and specifying a new file name.

Here are two sections along the roadway, illustrating the varying lane widths on the right side of the main centerline. They are viewed with the Input-Edit Section File command on the Section menu.
Pulldown Menu Location: Roads
Keyboard Command: tpcset
Prerequisite: Centerline file or polyline
This command creates a profile that sets a road design at an elevation to meet the specified overlay thickness along with leveling or milling thickness. The rehabilitation profile created by this command can then be used in Process Road Design to create the rehabilitation design including the rehabilitation surface, sections, quantities and linework.

The first dialog specifies the road design files. All these settings are the same as in Process Road Design except for the Output Rehab Profile. This profile is the output result for this command. The difference with Process Road Design is that the profile is an output instead of an input. Please see the Process Road Design section of the manual for a description of the other input files.

The second dialog has processing options. Again, many of these parameters are the same as Process Road Design. The settings specific to this command are the following:

**Rehabilitation Method:** This chooses between adding a leveling layer to the existing road or stripping the existing road by milling or grinding.

**Minimum Leveling Thickness:** This is the minimum fill thickness between the existing road and the bottom of the
overlay subgrade of the new road.

**Minimum Milling Thickness:** This is the minimum cut thickness between the existing road and the bottom of the overlay subgrade of the new road.

**Overlay Thickness:** This is the depth of the overlay subgrade of the new road. This value should match the subgrade thickness defined in the template.

**Template IDs to Rehab:** These are the grade IDs from the template definition to process for the overlay. The Select button can be used to graphically pick the template IDs. Multiple IDs can be specified by entering the IDs separated by commas. For example, if a road has two lanes with two grades for overlay and the template IDs are LANE1 and EP, then enter "LANE1,EP" in the dialog.

---

**Example 1: Milling**

In this case, the existing road will be trimmed by the specified milling thickness.

**Step 1: Define Centerline**
Use a routine from the Centerline menu to create the .CL file. For example, for entering design plans, use Input-Edit Centerline File. For using the geometry of a polyline, use Polyline To Centerline File.

**Step 2: Define Template**
Run Design Template to create a .TPL file. In this case, the template will be a two lane road with 12’ lanes and -2% cross slopes. That's the minimum that needs to be defined for the rehabilitation design. The cut/fill slopes are not required.
Step 3: Existing Surface
The existing surface can be either a triangulation model or cross sections of the existing road. To create a triangulation surface, you need 3D data for the existing road (points and breaklines) and then run Triangulate & Contour to create a .TIN file. To create cross sections, use the routines in the Sections menu for Input-Edit Section Alignment to set the section intervals and then run one of the Create Section routines to make a .SCT file.

Step 4: Road Rehabilitation Profile
Run this command and specify the 3 files created in steps 1-3. Also set the output profile to create the .PRO file. On the second dialog, choose the Milling method. Set the Milling Thickness to 3 inches. Set the Overlay Thickness to zero since the template doesn't have a subgrade. Set the Template ID to EP to match the grade from the template.

Step 5: Process Road Design
Run this command and specify the 4 files created in steps 1-4. Also set the output Design Section file to create a .SCT file for the rehabilitation design.

Output:
The report includes the total cut and cuts per station which is the quantity of the milling.

Process Road Design
Template File> C:\sample\rehab.tpl
Profile File> C:\sample\rehab1.pro
Existing Surface File> C:\sample\road-ex.sct
Centerline File> C:\sample\simo2.cl
Design Section Output File> C:\sample\rehab1.sct

Processing 0+00.000 to 14+41.464
Total Cut : 9203.469 C.F., 340.869 C.Y.
Total Fill: 0.000 C.F., 0.000 C.Y.

Use Input-Edit Section File or Draw Section File to view the design and existing sections.

Example 2: Milling with Overlay

This example adds an overlay thickness to the design from example 1. The steps are the same except for the following:
Repeat Step 2: Design Template
Add a subgrade below the EP grade with a depth of 6 inches.
Repeat Step 4: Road Rehabilitation Profile
Use the same settings as example 1 except set the Overlay Thickness to 6 inches.

Repeat Step 5: Process Road Design
Run this command again with the updated Template and Profile.

Output:
The report includes the updated milling cut quantities along with the overlay subgrade volumes. Since the Milling Thickness stayed at 3 inches, the cut quantities stayed the same as example 1. The Overlay Thickness being thicker at 6 inches leads to more subgrade quantities and raises the new road above the existing in areas.

Process Road Design
Template File> C:\sample\rehab.tpl
Profile File> C:\sample\rehab1.pro
Existing Surface File> C:\sample\road-ex.sct
Centerline File> C:\sample\simo2.cl
Design Section Output File> C:\sample\rehab1.sct
Processing 0+00.000 to 14+41.464
Total Cut : 9203.673 C.F., 340.877 C.Y.
Total Fill: 0.172 C.F., 0.006 C.Y.
Example 3: Leveling

This example applies leveling to an existing road. The steps are the same as example 1 except for the following:

**Repeat Step 4: Road Rehabilitation Profile**

On the first dialog, use the same data files as example 1. On the second dialog, choose the Leveling method. Set the Leveling Thickness to 3 inches. Set the Overlay Thickness to zero since the template doesn't have a subgrade. Set the Template ID to EP to match the grade from the template.

**Repeat Step 5: Process Road Design**

Run this command with the same settings as example 1. The only difference is that the profile is set for leveling instead of milling.

**Output:**

The report includes the total fill and fills per station which is the quantity of the leveling.

Example 4: Leveling with Overlay

This example adds an overlay thickness with a minimum of 4 inches to the design from example 3. Part of the overlay will be in the subgrade of the template and the rest will be in the Min Leveling Thickness setting. The steps
are the same as example 3 except for the following:

**Repeat Step 2: Design Template**
Add a subgrade below the EP grade with a depth of 2 inches.

![Design Template](image)

**Repeat Step 4: Road Rehabilitation Profile**
Use the same settings as example 3 except set the Overlay Thickness to 2 inches and set the Min Leveling Thickness to 2 inches.

**Repeat Step 5: Process Road Design**
Run this command again with the updated Template and Profile.

**Output:**
The report includes the updated leveling fill quantities along with the overlay subgrade volumes.

![Processing Results](image)

**Process Road Design**
Template File> C:\sample\rehab.tpl
Profile File> C:\sample\rehab1.pro
Existing Surface File> C:\sample\road-ex.sct
Centerline File> C:\sample\simo2.cl
Design Section Output File> C:\sample\rehab1.sct

Processing 0+00.000 to 14+41.464
Total Cut : 0.000 C.F., 0.000 C.Y.
Total Fill: 3228.086 C.F., 119.559 C.Y.
Example 5: Leveling with Overlay and Match Slopes

This example modifies example 4 to have the new road cross slopes match the existing cross slopes instead of being at a fixed design of -2%. The steps are the same as example 4 except for the following:

**Step 2: Define Template**

There are several methods to modify the template for transitions. For this example, the Template Grade Table command is used. This command defines slope and distance transitions for template grades. In this example, we will only use the slope transitions to make the design slopes match the existing road.

Run the Template Grade Table command and create a new .TGT file. Select the rehab template that was used in example 4 as the template to process. In the dialog, highlight the EP grade from the list for the Left Surface. Then pick the Match Slope button. Select the section file for the existing road. Next there is a dialog to set the range of stations to process and the reference offset points which are used to sample the existing surface to get the slope between these offsets. In this example, the full station range is used and the offsets are 0 for the center and -12 for the left EP.

Next, highlight the EP grade from the list for the Right Surface. Then pick Match Slope and select the existing section file. For the offsets, use 0 and 12.

Then back on the main dialog, pick the Save button.

**Repeat Step 4: Road Rehabilitation Profile**
Use the same settings as example 4 except set the Template Grade Table on the first dialog.

**Repeat Step 5: Process Road Design**

Run this command again with the updated Template and Profile.

**Output:**
The report includes the leveling fill quantities along with the overlay subgrade volumes.

**Example 6: Leveling with Overlay and SuperElevation plus Lane Widening**

In this variation, the new road has both overlay and new design changes of applying new superelevation and widening a lane. The steps that are different than example 4 are described here.

**Step 2: Define Template**

For this example, the template has additional design elements besides the overlay grades. Run the Design Template command to add the new elements.

First, pick the Grades button to add a new grade for the new lane using a slope of -2%, distance of 12 and ID of EP2. Then add a new grade for a shoulder with slope of -4%, distance of 3 and ID of SH. Next, subgrades are needed for the new lane since this isn’t over the existing road. Add a subgrade of 4 inches of asphalt under the new lane and another subgrade of 8 inches of gravel. Next pick the Cut button and set the cut slope to 2:1 and pick the Fill button and set the fill to 2:1. The cut/fill slopes are needed to tie the new road design elements to the existing surface.
Finally, pick the Super button to set the superelevation transition ID's as EP2 so that the shoulder stays outside the super. Then pick the Save button.

Even though the template has the new lane EP2 defined for both sides, let's actually only apply this new lane for a range of stations on the left side. Run the Template Grade Table command and make a new .TGT file. Select the template file that was just created. Then pick EP2 on the Right Surface list. In the table, fill in the first row with station 0 and a distance of 0. This will eliminate EP2 on the right side. Then pick on EP2 from the Left Surface list. Fill out the table as shown to make the new lane start at station 3+00, reach full size at 3+36, start transitioning back at station 9+00 and return to zero at station 9+36.
Another template transition definition to create is the superelevation. Run the Input-Edit Super Elevation command and create a new .SUP file. Use the option to select a centerline and specify the speed table to have the program set the transition stations. Or use the Add function to manually enter the transition stations and full super slope.

**Repeat Step 4: Road Rehabilitation Profile**
Use the same settings as example 4 except use the new template (TPL), template grade table (TGT) and superelevation (SUP) created in step 2.

**Repeat Step 5: Process Road Design**
Run this command again with the new template, profile, template grade table and superelevation.

**Output:**
The report includes the leveling fill quantities along with the overlay subgrade and the quantities for the new road elements.
Centerline File> C:\sample\simo2.cl
Template Grade Table File> C:\sample\rehab.tgt
SuperElevation File> C:\sample\rehab.sup
Design Section Output File> C:\sample\rehab1.sct

Processing 0+00.000 to 14+41.464
Total Cut : 3549.129 C.F., 131.449 C.Y.
Total Fill: 22519.407 C.F., 834.052 C.Y.
Total Left Subgrade2 - Asphalt: 2399.867 C.F., 88.884 C.Y., 7200.000 S.F., 800.000 S.Y.
Total Left Subgrade3 - Gravel: 4799.622 C.F., 177.764 C.Y., 7200.000 S.F., 800.000 S.Y.
Total Right Subgrade1 - Asphalt: 2882.569 C.F., 106.762 C.Y., 17296.127 S.F., 1921.792 S.Y.

These sections show the road at a station before the new lane and superelevation and at a station with the

Example 7: Leveling with Overlay with Lane Widening at New Crown position

In this variation, the existing road has two 10' lanes that are being expanded to 12' lanes. The left EP is staying fixed and the extra 4' is added to the right side. So the crown is shifting 2' to the right. The steps are the same as example 4 except for the changes to the template definition.

**Step 2: Define Template**

Use the Define Template command to make the template overlay and widening grades. For this example, there is one 10' grade on the left side for the overlay plus a 3' shoulder. On the right side, there are four grades. The first right side grade is 2' for the portion of the overlay that is shifting the crown over. The second grade is 8' for the remainder of the right side overlay. The third grade is 4' for the widening. The fourth grade is a 3' shoulder. The template has subgrades of 2" for the overlay grades and has two subgrades of 4" of asphalt and 8" of gravel for the widening grade. Since this template is asymmetrical, uncheck the toggle for Right Side Same As Left.

Next pick the Cut button and set the cut slope to 2:1 and pick the Fill button and set the fill to 2:1. The cut/fill slopes are needed to tie the new road design elements to the existing surface.
Repeat Step 4: Road Rehabilitation Profile
For the input files, use the template created in step 2, the centerline and existing surface. For the process options, choose the Leveling method and enter 2 inches for the Leveling and Overlay thicknesses. For the Template IDs, specify both EP and EP2 since both of these are overlay grades.

Repeat Step 5: Process Road Design
Run this command with the new template and profile.

Output:
The report includes the leveling fill quantities along with the overlay subgrade and the quantities for the new road elements.

Process Road Design
Template File> C:\sample\rehab.tpl
Profile File> C:\sample\rehab1.pro
Processing 0+00.000 to 14+41.464
Total Cut : 3462.106 C.F., 128.226 C.Y.
Total Fill: 8523.772 C.F., 315.695 C.Y.
Total Left Subgrade1 - Asphalt: 2402.152 C.F., 88.969 C.Y., 14413.199 S.F., 1601.467 S.Y.
Total Right Subgrade2 - Asphalt: 1921.865 C.F., 71.180 C.Y., 11531.712 S.F., 1281.301 S.Y.
Total Right Subgrade3 - Asphalt: 1921.510 C.F., 71.167 C.Y., 5765.856 S.F., 640.651 S.Y.
Total Right Subgrade4 - Gravel: 3842.962 C.F., 142.332 C.Y., 5765.856 S.F., 640.651 S.Y.

Pulldown Menu Location: Roads
Keyboard Command: rdrehab
Prerequisites: Centerline, template and surface files

Define Road Design Parameters

This command defines design parameters that can be checked against a road design with the Process Road Design and Road Network commands. Only fill in the parameters to have checked. If you leave a parameter blank, then that parameter is not checked. You can have a different set of parameters for different stations along the road in case road conditions change such as different speed limits. The different sets of parameters are listed by station on the left of the dialog. Use the Add button to add a new parameter set and use the Remove button to remove the set highlighted in the station list. To view a parameter set, pick the station in the Stations list. If you don't need different sets of parameters, then leave the Starting Station as zero and don't add other stations.
Starting Station: This is the station to begin using the current set of design parameters.
Max Slope: This is the maximum profile slope percent that is allowed.
Max Distance at Max Slope: This is the maximum continuous distance that the profile can be at the max slope.
Min Slope: This is the minimum profile slope percent that is allowed.
Min Curve Radius: This is the minimum horizontal curve radius for the centerline.
Min Curve Radius for Delta Angle Range: This is the minimum horizontal curve radius for the centerline for curves with a delta angle in the specified range. Enter the delta angles in decimals degrees from low to high.
Min Sight Distance: This is the minimum sight distance for the profile.
Min K-Value: This is the minimum k-value for the profile.
Max Slope at Intersection: This is the maximum profile slope at an intersection with another road. The Setback is the distance along the profile from the intersection point that this max slope applies. This option only applies to Road Network.
Max Percent of Road over Slope: This is the maximum percent of the road that can be over the specified Slope.
Min Vertical Curve Length for Delta Slope over: This is the minimum vertical curve length for PVI's with an algebraic grade difference greater than the specified Delta Slope. The Delta Slope units are in percent slope.
Min Vertical Curve Length for Delta Slope between: This is the minimum vertical curve length for PVI's with an algebraic grade difference between than the specified Delta Slopes. Enter the delta slopes in percent slope format from low to high.
Max SuperElev Rate of Change Per 100: This is the maximum rate of change in the superelevation for the cross slope. The rate units are in percent slope per 100 feet or meters depending on your drawing units.
Check for Tangential Centerline: This option checks the horizontal alignment to make sure all the segments are tangential.
Check for Flat Areas: This option checks the superelevation at the Run-In and Run-Out stations where the outside lane is flat and warns if the profile is also flat at those stations.
Max SuperElevation: This is the maximum superelevation cross slope at full super for different curve radii. A lookup table of curve radius and max slope is used. The curve radii should be entered from low to high.
The Horizontal and Vertical Speed Tables are for referencing values to fill in for the design parameters.

Pulldown Menu Location: Roads
Keyboard Command: rdparam
Prerequisite: None

Vehicle Path Tracking
This command traces the wheel paths for vehicle dimensions along a centerline. The centerline is defined by a polyline which must be created before running this command. The center of the front axis follows this centerline. After specifying the vehicle dimensions and draw options in the command dialog, the program prompts for the centerline polyline and then draws the paths.
**Wheel Width:** Distance along the wheel axis to the outside of the tires.

**Wheel Length:** Distance between the front axis and rear axis.

**Vehicle Width:** Outside width dimension of the vehicle body.

**Front Overhang:** Distance from front axis to front of vehicle body.

**Rear Overhang:** Distance from rear axis to the back of the vehicle body.

**Draw Vehicle Icons:** Draws the vehicle symbol with the dimensions at the specified **Station Interval** along the centerline.

The **Save** and **Load** buttons save and recall the vehicle dimensions to a .VHP file.

For hinged vehicles, pick on the Trailer Tab and turn on the Use Trailer toggle. There is a separate set of dimensions for the trailer and separate layers for the trailer points to track.
Prompts

Vehicle Path Tracking dialog
Select centerline polyline: *pick a polyline*

Pulldown Menu Location: Roads
Keyboard Command: auto_track
Prerequisite: Centerline polyline

Template ID Library

This command defines template ID’s along with associated descriptions. The ID’s can be selected in Design Template when adding grades, curbs or medians. The descriptions are only for identification during the ID selection. In Design Template, there are Set buttons next to the ID edit fields that select from the list of ID’s defined in the Template ID Library. The purpose of the Template ID Library is to help with consistent naming of template elements.

The current Template ID Library is stored in the current USER folder under Documents & Settings in a file calledtplidlib.dta. The Load and SaveAs functions can be used to store and recall ID settings to a .TID file.
### Pulldown Menu Location: Roads

### Keyboard Command: tplid.lib

### Prerequisite: None

## Process Road Design

The primary function of this command is to assemble all of the components for a road design and process them together. While all of the Input Files can be created prior to accessing the Process Road Design command, all can be edited from the Road Design Files dialog, and many files can actually be created from the Road Design Files dialog itself. The actual processing of the Road Design essentially applies the design template at the design profile elevation along the specified centerline and computing the outslopes and earthworks relative to the existing ground surface. The earthworks report can be shown in the standard report viewer or customized with the Report Formatter option. Secondary functions include creating a final grade section file for plotting with the Draw Section File command, creating final grade points in a coordinate file, creating a final surface/contour model, and drawing the road as 3D polylines. You can also output a mass haul diagram profile. The program also has options for applying a superelevation file, template transition file, template point profile, template point centerline, rock section file, an as-built existing section file and a topsoil removal file. Process Road Design can be used not just for final road design computations but for levees, channels and any template-based application.

This command begins with the dialog shown below. The top section contains input Files. In a typical implementation of this command, you will have already defined a horizontal centerline for the design to follow, however, you could actually pick the Centerline button, pick the New tab, name the new centerline file (.CL), pick Open, and then back in the main Road Design Files dialog, pick the Edit button and layout the centerline design. The only component that you must have already created before running Process Road Design is #4, an Existing Surface file. As long as there is an Existing Ground Surface, the command will generate the Existing Ground Profile automatically, and the Proposed Finish Grade Profile can be created with the Edit button. Even a Design Template can be created right from here as well. Ultimately, the top 3 Input items (Centerline, Design Profile, and Design Template/Series) are required to Process a Road Design, leading to final sections and full contouring and 3D viewing. The Existing Surface is needed as well to process with earthwork calculations and tie slopes.
Input items 5 through 11 are strictly optional design files. It should be pointed out that items 8 and 9 (Template Point Profile and Template Point Centerline) enable template IDs to follow any defined centerline or profile and provide total flexibility of design. Lane widening, matching existing curb lines, special ditches, etc. can be easily accomplished with these two options. The template IDs simply "string along" or follow these pre-defined alignments, and the rules of the template apply to all other template ID points.

The Output Files section allows you to specify files to store the processing results. The Section File creates a final grade section file that can be drawn with Draw Section File. The Topsoil Section File creates the modified existing ground section file if Topsoil Removal is set in the input. This "post-topsoil removal" section file can be used for earthworks calculations to compare any stage of work, using Calculate Sections Volume under the Section pulldown menu. The Coordinate File creates a coordinate file containing every break point in the final grade. The point descriptions include the station, offset and template ID. Whether to include the subgrade points as well as the final surface points is determined by the Include SubGrade Points in Output CRD File option on the next dialog. To the right of the Output Files is the option to create new output files or append to existing output files. If you extend the road, or revise a portion of the project, you can simply "Append" rather than overwrite. The first time that you run this command for stations 0-1000, you would set Output Files to New. Then you could run this command again, possibly with new inputs, for stations 1000-2000 and set Output Files to Append.

On the next dialog, there is a Save Settings button to store all the settings from the first and second dialogs into a specified Road Design File with an (.RDF) file extension. Recorded (.RDF) files can be recalled later using the Load Settings option.

1. **Centerline**

Specify the name of the Centerline file with this option. The (.CL) file contains the horizontal alignment geometry for a project. This parameter file must be specified if you want to have earthworks centroid corrections computed, generate final coordinates, Disturbed Area Polyline, and/or use Triangulate & Contour. The centerline file can be created by the Design Centerline or Polyline to Centerline commands in the Design pulldown menu.
Specify the design profile (.PRO) file to derive the centerline elevations when the template is applied. This file defines the vertical alignment and is always required. The profile can be created with any of the profile creation routines in the Profile menu, but typically you would use Design Road Profile or Input Edit Profile.

Specify a template definition (.TPL) file or template series (.TSF) file that defines the final grade offsets and elevations and the cut/fill slopes. The template file is created by the Design Template command and the template series file (a set of templates ordered by range of stations) is created using Input-Edit Template Series. A single template file or a template series file is required to run Process Road Design.

Specify the surface model which will be treated as the existing ground for cut and fill volumes and to calculate the outslope intersections when the template is applied at the profile elevations. This Existing Surface can be defined by either a section file or triangulation. The section file can be created with commands such as Sections from Surface Entities, Input/Edit Section File, Sections from Points or one of the Digitize Sections commands on the Section menu. The triangulation file can be created with the Triangulate & Contour command.
5> Rock Section File

This option specifies an optional rock section file that is used as an additional surface. When in cut, a special cut slope is used up to the intersection of the rock surface. After this intersection, the normal cut slopes apply. The special rock cut slope is specified in Design Template under the cut options. If the "pivot point" in cut is below the rock line, then the special rock cut slope will be applied. Note that rock sections can be derived from borings to rock, as modeled, or can be created quickly by using the "translate" command within Input-Edit Section File to translate the existing ground sections by a vertical offset (e.g. -6) to an approximate top of rock.

6> Template Transition File

Specify a .TPT file with this option. The Template Transition file allows modified template files to be applied at different ranges of stations on a project. In this way, template IDs can be made to widen (as for passing lanes) and contract. Use the Template Transition command under the Design menu to create a template transition file.

7> Super Elevation File

This option is used to specify a super elevation file (.sup file) that defines the super elevation transition stations on a project. The super elevation file can be created with the Input-Edit Super Elevation command.

8> Template Point Profile

This option lets you have separate profiles for template points that are independent of the centerline profile. This design file is created with the Assign Template Point Profile command.

9> Template Point Centerline

This option lets you have separate centerlines for template points that are independent of the main centerline. This design file is created with the Assign Template Point Centerline command.

10> Template Grade Table

This input file is optional. The Template Grade Table is a method for template transitions that uses a lookup table of distance and slopes at transition stations for each template ID. This design file is created with the Template Grade Table command.
Topsoil Removal

This option applies topsoil removal and/or replacement to the existing ground section file. This design file is created with the Topsoil Removal/Replacement command.

As-Built File

The As-Built File is a cross section file used to match existing grade and retain as-built portions of a road improvement project. The final cross sections will conform to the as-built cross sections for those template IDs specified in the second dialog. Beyond the specified set of offsets in the as-built cross section file, the design road files will be applied.

Road Design Parameter

This input file is optional for running checks on the road design for parameters such as min sight distance and max grades. This .RDP file is created with the Define Road Design Parameters command.

Output Design Section File

Specify the name of the file to output the final grade sections calculated by applying the template file at profile elevations and calculating the outslope intersection with the existing ground cross sections. This file can then be plotted by using the Draw Section File command. After plotting the final sections overlaid on the existing sections, revisions can be made graphically with commands like PEDIT and Polylne by Slope Ratio. The data output to the file can also be edited and reviewed with the Input-Edit Section File command. If the final sections are edited graphically, the revised section data can be updated in the .SCT file with the Polylne to Section File command.

Output Existing Section File

This option creates a section file of existing ground. This applies when the existing surface is a triangulation file. The station intervals for the existing section file will match the stations from the design section file.

Output Topsoil Section File

This option writes out a modified existing ground section adjusted by the topsoil removal. This option is only valid if a Topsoil Removal file is being used.

Output Coordinate File

This option creates a coordinate file containing every break point in the final grade for the range of processed stations. Using the second dialog, there are additional options to output subgrade and ditch/berm points. The point descriptions include the station, offset and template ID. The station interval is set by the stations in the Existing Section File.

Output Mass Diagram File

The mass haul diagram can be output as a profile file and shows the cumulative cut and fill along the selected range of stations. Cut and fill is balanced between points on the mass haul profile that cross the Z-axis. Because
of the typically large values of cut and fill associated with road and earthwork projects, the vertical scale for the profile may need to be set to 10 times the horizontal scale, or more. The profile preview screen which appears when you select profile for loading will show the elevation range and help suggest an appropriate vertical scale.

19> Super Elevation Diagram File

This option writes out a super elevation transition file (.SUD) that can be used with the Draw Super Elevation Diagram routine. This file contains the template cross slopes and the transition stations.

Running the Road Design Job

After setting up the files and options in the first dialog click the OK button. The next dialog shown below has processing options.

In the Process Options section, the Range of Stations to Process field sets the range of station that you want to calculate. Each time you use this command, the existing grade (.SCT) file is scanned and the range in the edit box is set to the minimum and maximum stations in the file. If you change the station range, you can click the Full Range button to restore the default full range of stations.

The Settings button will interpolate additional existing cross sections (internally) and create final cross sections at special stations like profile high and low points, profile transition stations for PVC and PVT, key centerline points like PC’s and PT’s, and superelevation and template transition points and any user-defined special stations. These additional station improve volume calculations.

Volumes are calculated using end areas between the range of stations. Also under the Settings button, there are controls for the cut/fill starting and ending stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station. You can also specify cut/fill gaps to stop the end area volume calculations over the station range of that gap. This applies in cases like a bridge.
The *Edit Design Sections Before Final Processing* does just that. You can review and edit the final sections in the spreadsheet with graphic view editor similar to the Input-Edit Section File command. For example, you can change the tie slope as selected stations. After making these changes, the modified final sections are used for the rest of the road design process including earthworks and drawing output.

The *Station Interval* and *Existing Section Max Offset* buttons are ghosted if the existing surface is a set of cross sections. If there is no existing surface, or the existing surface is a grid, TIN or FLT file, then you must enter the Station Interval to generate sections along the centerline. Besides the stations at interval, sections can be created at special stations as specified under the Settings button. The *Existing Section Max Offset* controls the max left and right offsets for generating the existing sections when the Existing Surface is defined by a triangulation file. This offset needs to be set far enough for the final sections outslopes to tie into existing. On the other hand, keeping this offset fairly close to the tie point will help make processing run faster.

The *Calculate Centroid* option applies to centerlines containing curves. The centroids of the cuts and fills will be computed, and the radius to these centroids will be calculated. Then the effective interval will be computed between cut and fill centroids. In this way, in a tight curve where fill is concentrated to the outside of the curve and cut is concentrated to the inside of the curve, fill will be increased and cut will be reduced. This also increases the accuracy of volume calculations.

The *Use Takeoff Strata* option uses the strata surfaces created in the Takeoff module to report the strata cut volumes both for the total strata volumes and the strata end areas per station. This method allows for unlimited strata definitions with advanced modeling techniques including Kriging and Inverse Distance to model strata surfaces. In Takeoff, the Drillhole/Strata Settings command is where you define the strata names and modeling methods. Next, the Place Drillhole command creates the drillholes. Once the drillholes are entered, use the Make Strata Surfaces command to build the strata surfaces which are stored as TIN files and associated with the current drawing.

The *Template ID for Profile* allows the profile grade to be applied to another template ID point other than the centerline. This feature might apply, for example, to a 2-lane road that will eventually be part of a 4-lane road being built in stages. The first-stage, 2-lane road would be fully symmetrical and designed around the crown of the road, but the template profile might be one of the edge of pavements. You can specify the template ID (e.g. EP), and
whether the left or right side ID should be used to apply the profile grade.

The *Shrink* and *Swell Factor* edit boxes allow you to specify a value that the volume calculated will be multiplied by. If you specify any number other than one an additional report showing accumulated adjusted volumes and differences will be produced.

The *Vertical Offset of Profile* edit box will place the template at the profile grade as raised or lowered by the entered offset. The *Horizontal Offset of Template* will shift the template left or right on the centerline by the specified amount. Use a positive value to offset to the right and use a negative value to offset left. This option is useful, for example, when one side of a divided highway is built years before the other side is to be started. In this case, you could define a normal template with a crown in the middle, but would enter a horizontal offset from the crown of the road to the actual centerline of the divided highway.

The *Slope Perpendicular To* option defines the slope projection method. The centerline method creates the template cut/fill slopes perpendicular to the centerline. The Slope Direction method accounts for the slope of the profile and makes the final surface to match the template cut/fill slope. For example, if the profile is at a 10\% slope and the fill slope is at 2:1, then the Centerline method would create fill slopes that are 2:1 perpendicular to the centerline while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the profile. For the same case except with the Slope Direction method, the resulting slope perpendicular to the centerline is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

The *Report and File Output Options* include settings for reporting final coordinates (if specified in the previous file output dialog), as well as special features.

The *Report Precision* controls the number of decimal places.

The *Use Report Formatter* option allows you to customize the fields to report and their order. It also can output the report to MS Excel or databases.

The *Report Subgrade Areas* option will include an additional line in the report for the end area of each subgrade material.

The *Report Centroids* toggle controls whether the shift in the cut or fill centroid radius shift will be included in the earthworks report.

The *Report Cut/Fill Text* option greatly expands the size of the report by presenting the cut and fill end areas at each station. A sample of the cut/fill text report is shown below. Volumes by end area method are presented between each line containing station and end areas of cut, fill and optionally rock.

<table>
<thead>
<tr>
<th>Station</th>
<th>Cut (sf)</th>
<th>Fill (sf)</th>
<th>Rock (sf)</th>
<th>Interval</th>
<th>Cut (cy)</th>
<th>Fill (cy)</th>
<th>Rock (cy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3+00.00</td>
<td>0.00</td>
<td>101.07</td>
<td>0.00</td>
<td>50.00</td>
<td>313.78</td>
<td>93.58</td>
<td>0.00</td>
</tr>
<tr>
<td>3+50.00</td>
<td>338.88</td>
<td>0.00</td>
<td>0.00</td>
<td>6.09</td>
<td>80.93</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3+56.09</td>
<td>379.10</td>
<td>0.00</td>
<td>0.03</td>
<td>43.91</td>
<td>824.60</td>
<td>0.00</td>
<td>31.84</td>
</tr>
<tr>
<td>4+00.00</td>
<td>634.92</td>
<td>0.00</td>
<td>39.12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The *Report Cut/Fill Differences* option will report the cut/fill ratio and balance at each station.

The *Report Cumulative Cut/Fill Differences* option will report the running totals of cut/fill at each station.

The *Report Final Station-Offset* option will create a report of the final section offset-elevation data in row-column format. The station and profile grade are shown on the left followed by columns of offset and elevation for each data point. There are options to report the surface points only, the subgrade points only or filter the points by ID.
Write SMI Chain File creates a chain (.CH) file that contains the centerline, profile and template data for SMI Construction V.

The As-Built IDs to Use option applies only if you have specified an as-built section file as one of the inputs in the previous dialog. Consider a normal road template with 20 feet to edge of pavement (EP) and 10 feet more to shoulder (SH). Going further, assume that when you run this template, it does a fill condition on the right and creates a TIE point. If you wanted to conform the template to match a wider section of road at certain stations, you could edit the output file of a normal run (using Input-Edit Section File) and create new offsets and subgrade points for widening and even force a trapezoidal ditch in cut, as shown in the entries below:

<table>
<thead>
<tr>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
<th>Ratio(%)</th>
<th>Slope(%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>21.33</td>
<td>EP</td>
<td>-50.00</td>
<td>-2.00</td>
</tr>
<tr>
<td>13</td>
<td>21.33</td>
<td>SUBGRADE1-3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>31.60</td>
<td>SH</td>
<td>-25.00</td>
<td>-4.00</td>
</tr>
<tr>
<td>15</td>
<td>21.33</td>
<td>SUBGRADE1-4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>30.60</td>
<td>BD</td>
<td>-2.00</td>
<td>-50.00</td>
</tr>
<tr>
<td>17</td>
<td>40.00</td>
<td>ED2</td>
<td>Flat</td>
<td>0.00</td>
</tr>
<tr>
<td>18</td>
<td>46.00</td>
<td>TIE</td>
<td>2.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Because all the other offsets to the left match by default, this editing will force the template to conform from offsets 21.33 right to the tie at 46 right. As you try different design template or other changes in Process Road Design, this as-built information would hold for the specified station. Alternately, you could edit the final cross section directly in Input-Edit Section File. Note that you can use distinct, new ID points like BD2 which are not found in the template file, and they will be created if part of the as-built cross section file, and if referenced as As-Built IDs to Use. This As-Built method works best when inserting controlled section defined from TIE left to TIE right, which get inserted as completed sections in a run of Process Road Design.

The Output CRD File options apply when a Output Coordinate File is specified in the first dialog. These options allow you to output any combination of template surface, subgrade, ditch and berm points. The Output CRD To Use Sta-Off Desc option sets whether to include the station and offset in the description for each point. Here are example coordinates for station 0+90:

PtNo. North(y) East(x) Elev(z) Description
122 189497.42 611730.32 90.01 TIE 0+90.00L53.65
123 189461.43 611733.72 108.09 SHD 0+90.00L17.50
124 189457.45 611734.09 107.93 CURB3 0+90.00L13.50
125 189456.95 611734.14 107.93 CURB2 0+90.00L13.00
126 189456.95 611734.14 107.93 CURB1 0+90.00L13.00
127 189455.96 611734.23 107.93 EP 0+90.00L12.00
128 189444.01 611735.36 107.33 CENTER 0+90.00R0.00
129 189432.06 611736.49 107.09 EP 0+90.00R12.00
130 189431.07 611736.58 107.09 CURB1 0+90.00R13.00
131 189431.07 611736.58 107.93 CURB2 0+90.00R13.00
132 189430.57 611736.63 107.93 CURB3 0+90.00R13.50
133 189426.59 611737.00 108.09 SHD 0+90.00R17.50
134 189412.18 611738.36 107.85 TIE 0+90.00R31.97

The Drawing Output Options bottom section of the Additional Earthworks Parameters dialog contains output options which are only available when a centerline file is specified.

The Triangulate & Contour option will automatically run this command after Process Road Design is done to create the final contours. Triangulate & Contour uses the template 3D polylines to model the final surface, and the disturbed area polyline is used as the inclusion perimeter for the contours. With Triangulate & Contour clicked on, the Setup button becomes active. Picking Setup brings up the Triangulate & Contour settings including the contour interval and whether to draw 3D Faces. Also under Setup, there are controls for the colors of the 3D Faces for each template break point. With Triangulate & Contour active, Draw Template Polylines and Draw Disturbed Area Polyline are automatically turned on. The Merge Road With Existing option combines the road design triangulation with the existing ground surface and stores the resulting triangulation in the file specified with the Set button. This
option is available when the Existing Surface is a triangulation file and the Triangulate & Contour option is active.

The *Erase Previous Road Entities* option will erase any entities from the drawing that were created in a previous run of Process Road Design using the same design files. This option allows you to easily re-run Process Road Design and update the drawing entities after changing one of the road design files.

The *Draw Cross Section Polylines* option will create 3D polylines perpendicular to the centerline with each template break point. The interval of these cross section polylines is determined by the station interval of the Existing Sections.

The *Draw Template Polylines* option will create 3D polylines parallel to the centerline by connecting common template point IDs. For example, a template ID could be EP which this option would use to create 3D polylines for EP on the left and right of the centerline. Which template point IDs to connect is set under *Template IDs to Draw*. Setting this to an asterisk (*) will plot all the template break points. The *Select* button shows cross sections of the final templates for graphical selection of the ID's to draw.

Likewise, the *Draw Subgrade Polylines* option will create 3D polylines parallel to the centerline for the specified subgrade breakpoints.

The *Draw Disturbed Area Polyline* option will create a polyline perimeter that represents where the cut/fill slopes tie into the existing ground.

*Draw Template Slopes* creates slope arrows parallel to the centerline at the specified template ID's. For example, this option can be used to show the slope direction and amounts along the template flowline. The style of the slope arrows is set under the *Set Slopes* button at the bottom of the dialog.

*Draw Cross Section Slopes* create slope arrows perpendicular to the centerline at the specified template ID's. For example, use this option to show the cross section slope of the pavement lanes. The cross section interval is controlled by the station interval under Process Options. The style of the slope arrows is set under the *Set Slopes* button at the bottom of the dialog.

*Label Profile On Centerline* creates labels in plan view for the profile stations, elevations and slopes as well as high and low points. This option has the same functionality as the command by the same name in the Profiles menu.

The *Draw Cut/Fill Direction Arrows* option will draw arrow indicators for cut or fill slope direction. The arrows are drawn in plan view and usually are drawn together with the *Draw Disturbed Area* and *Draw Cross Section* options. Cut arrows start from the disturbed area limit and point towards the centerline. Fill arrows start from the base of the fill slope and point away from the centerline. The *Solid Cut Arrows* option chooses between solid fill or wire-frame cut arrows. These arrows, especially when drawn as solid cut arrows, help distinguish cut and fill at a glance, when in plan view. In the example below, fill from a berm is shown at the left and cut down to a ditch is shown at the right. The arrows will only draw if there is enough dimension in the cut and fill to fit the entire arrow. So the cut and fill arrows reveal the deeper cut and fill zones.
Prompts

Road Design Files dialog: Choose the design files

Additional Road Design Parameters

Road Design Report dialog

Trim existing contours inside disturbed area (Yes/No)? Y This prompt appears if Triangulate & Contour is on. This option will trim polylines with elevation that cross the disturbed area perimeter for the road.

Join final contours with existing (<Yes>/No)? Y This prompt appears if Triangulate & Contour is on. This option will join the final contours with the existing contours where they join at the disturbed area perimeter.

Portion of Earthworks Report:

Template File> C:\DATA\simo2.tpl
Profile File> C:\DATA\rd.pro
Existing Section File> C:\DATA\simo2.sct
Centerline File> C:\DATA\simo2.cl

Processing 0+25.000 to 7+51.152
Total Cut : 800563.177 C.F., 29650.488 C.Y.
Total Fill: 1554948.266 C.F., 57590.677 C.Y.

<table>
<thead>
<tr>
<th>Station</th>
<th>Cut (sf)</th>
<th>Fill (sf)</th>
<th>Interval</th>
<th>Cut (cy)</th>
<th>Fill (cy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+25.000</td>
<td>4407.456</td>
<td>0.000</td>
<td>25.000</td>
<td>4784.266</td>
<td>0.000</td>
</tr>
<tr>
<td>0+50.000</td>
<td>5926.559</td>
<td>0.000</td>
<td>25.000</td>
<td>5535.921</td>
<td>0.000</td>
</tr>
<tr>
<td>0+75.000</td>
<td>6031.029</td>
<td>0.000</td>
<td>25.000</td>
<td>4840.888</td>
<td>0.000</td>
</tr>
<tr>
<td>1+00.000</td>
<td>4425.290</td>
<td>0.000</td>
<td>25.000</td>
<td>3432.528</td>
<td>0.000</td>
</tr>
<tr>
<td>1+25.000</td>
<td>2988.971</td>
<td>0.000</td>
<td>25.000</td>
<td>2713.262</td>
<td>3.362</td>
</tr>
<tr>
<td>1+50.000</td>
<td>2871.676</td>
<td>7.262</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Portion of Final Station-Offset Report:

Final Surface Section Report

<table>
<thead>
<tr>
<th>STATION</th>
<th>P.G.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2+50.000</td>
<td>1013.444 59.619 18.000 12.000 0.000 12.000</td>
</tr>
<tr>
<td>2+75.000</td>
<td>1015.059 65.772 18.000 12.000 0.000 12.000</td>
</tr>
<tr>
<td>3+00.000</td>
<td>1016.499 71.547 18.000 12.000 0.000 12.000</td>
</tr>
<tr>
<td>3+25.000</td>
<td>1017.764 76.733 18.000 12.000 0.000 12.000</td>
</tr>
</tbody>
</table>
Existing Contours and Centerline

3D template polylines, disturbed area perimeter polyline and final contours
Review of 3 Methods of Transitioning Templates using Process Road Design

The 3 methods of template transitions and super elevation are:
(1) Template Transition and/or Super Elevation Files
(2) Template Point Profile and Template Point Centerline files
(3) Template Series file which transitions between multiple, named templates.

Road widening and lane transitions can be handled by all 3 methods. Special ditches are best handled by method (2), Template Point Profile and Template Point Centerline, especially since Template Transition files only work with lanes or portions of roads defined by the Grade button in Design Template. Template Transition files do not apply to cut and fill segments, unless they are designed as fixed features using the Grade button. Super elevation can often be handled by method (1) or method (3). Bear in mind that new lanes or template elements that emerge and then disappear need to exist as template ID points in all referenced templates, using all 3 methods. These template ID points can be set to 0.001 units from adjacent template points, then "told" to emerge and widen as new lanes with distinct slopes appear. The program will not transition templates that don't share common template ID points.

This deceptively easy looking example below might be approached by a combination of methods 1 and 2. For method 1 to apply (template transition), the slopes of the pavement lanes must be maintained according to the template definition from centerline to outside lane. The ditch portion will be handled by method 2 (template point centerline).

Assume Spouts Springs Road is a hillside road with a ditch cut on the left side and fill on the right side. The trapezoidal ditch is shown. We will design only from station 4+00 to station 6+94 where the intersection begins. The standard template of 10' left lane and 10' right lane might appear as shown below:

Note that if lanes are designed to expand, it's important that the subgrade (9" of paving, shown above) be defined as following the ID, and should not be set to a fixed distance. The "EP" ID is used in the dialog below (top of subgrade...
The right hand portion of this example would be entered as follows:

When you click "Add" within the Template Transition main dialog, you are presented with the above screen. Template transitions require that you specify the correct side of the road in the lower left, then click the Grade or lane to alter, which is the first lane on the right, which is set to 13.73 according to the plans. To make sure the lane is fully expanded from the standard 12 to the 13.73 at station 400, it is necessary to set the "Begin Transition Station" to something less than 400, as shown. Then if this "expanded" lane width does not transition back to standard 12 width, but changes again, you must click on "Link to next transition" and leave the "End Full Template" and "End Transition" stations blank. Then you click "Add" again for the final segment, which would be entered as shown:
First, you specify "Side to Apply" as "Right", then click the pavement lane and edit it to 30', as shown above. Referencing the plan view drawing for Spouts Road shown above, you transition from station 451.67 to the new 30' road lane width at station 556.69 and hold that to the "End Full Template Station", which is 694.00. Then you can enter an "End Transition Station" just past the end of the key station range, which internally would transition the template back to a standard width of 12' at 694.01 (a moot point as the end point of the project is station 694 for this exercise). The key to template transition is that it is designed to transition from normal to expanded or reduced dimension, then transition back to normal. It is ideal for use in passing lanes that appear and then transition back, but requires use of "Link to next transition" to handle a sequence of lane width changes as above. Therefore, where lane widths change often, and don't transition back to the normal template lane width, it is often best to use Template Point Centerline as the method of lane transitioning. We will apply that below to the ditch line.

When the template transition process is repeated for the left driving lane, you obtain a final Template Transition dialog as shown here:

For the left side, the first screen just starts things up by establishing 10.28 as starting left side dimension, then the "Link to next transition" option is used, and the width of 18 is entered, transitioning to 18 at station 554.21 and holding that to an end station of 764.34, transitioning "back" to 12 at the fictitious 764.35, well beyond the 400 to 694 station range of interest. When this template transition file is run in Process Road Design and Triangulate &
Contour is turned on within Process Road Design, the output clearly shows that the lane transitions have followed the lane expansions correctly:

However, it is easy to see that the "design ditch" on the left side of the road, at 2' wide, did not conform to the special ditch which hugs the shoulder at station 7+00 but transitions to further off of the shoulder at 4+00. This special ditch is best handled with Template Point Centerline. To complete the special ditch design, use Polyline to Centerline File on both ditch polylines, calling the inside polyline BD1.CL and the outside polyline BD2.CL, as a reference to the ditch IDs, BD1 and BD2. You can give them a starting station of 0. The stationing of the ditch polyline does not matter, since only the coordinates of the centerline in the command Assign Template Point Centerline are used to determine the template ID position. Within Assign Template Point Centerline, Add each of the ditch sides as shown:

Note that if the ditch always exists on the left side, the ditch grades can be defined using the Grade button in Design Template, rather than using the Ditch feature within the Cut button. For final results, run the Process Road Design command using a combination of the Template Transition File and the Template Point Profile.

The end result is a final drawing that uses the Template Transition file to create the correct edge of pavement and uses the Template Point Centerline file to track along the correct ditch polylines. This is shown below in the final drawing of the 3D polylines generated by Process Road Design:
The actual slope to the ditch on the left is held at the design of 3:1, or whatever exists within the template from shoulder (SH) to base of ditch (BD1) in cut. Shown below in the Input-Edit Section File screen editor is station 6+50, where the ditch is designed very close to the shoulder:

Note that the distance from BD1 to BD2 is irregular, based entirely on the plan view offset of the ditch polylines. Note also that BD1 to SH is 3:1, holding the defined slope. (The cursor position also can be used to verify slope of any portion of the section in "real-time"). Finally, note that the subgrade follows the widening and irregular position of the pavement lane EP for both left and right sides, since the subgrade offset from centerline was defined as EP.

Although superelevation can be handled by use of superelevation files, for most simple applications (2-lane roads in particular), a single curve with superelevation can be handled by a template series file, using only 3 templates: normal crown, reverse crown, full super. This is illustrated below, for a typical 2-lane road template:
The actual Template Series File will consist of 6 entries for one curve: Normal, Reverse, Begin Full Super, End Full Super, Reverse, Normal. You would only need to make one extra template, for simple roads, for every additional curve, for the full super condition, since normal and reverse crown remain the same. Note that the curbs, even on the high side, can be designed to slope downward and catch the shoulder drainage in Design Template by use of "special slope" of -1% in the curb design, or by entering a value for the added "Drop" across the gutter portion. Both methods create a downhill slope to the face of curb. So the above project might be designed as shown below in the Input-Edit Template Series command:

![Input-Edit Template Series File](image)

Note that beginning and ending stations are not necessary. If station 0.00 was omitted, Process Road Design would use the normal template in any case from station 0 to 250. Similarly, Process Road Design will use the normal template going forward from station 900 automatically.

**Review of 2 Methods of Matching Portions of Existing Roads**

There are two main techniques for tying new template designs into existing roads, which may apply to road expansions, urban re-paving, grade improvements and other renovation projects. As more and more roadwork involves road improvement rather than new road development, these techniques become more useful and critical to master. The two techniques are: (1) Use of Template Point Profile and Template Point Centerline files to match existing conditions on portions of roads that do not change, and (2) Use of the "As-Built" cross section feature as one of the input files. An advantage of the As-Built method is that you can insert section points with special IDs for special features, whereas the Template Point Profile and Template Point Centerline methods must follow template IDs that...
are found in the original, main template design file. But the Template Point or "string" method allows for calculating sections at any interval, while the As-Built section method will revise final sections only at stations found in the As-Built section file.

Consider this alley-way, which consists of a Belgian block style curb (no gutter) that is already in place. The plans are to remove a crowned asphalt alleyway and put in a bricked alleyway on sand, with a central, "depressed" rock drain of 1’ width, to avoid water draining against buildings that abut the alley. But the design must match an existing "Belgian block" style curb on the right side of the road, which will not be removed.

There is a new profile design involved, and a new template. However, the right side of the template will meet the exact grade and offset of the in-place curb, which has been surveyed as back of curb (CB3). Then the command Offset 3D Polyline was used to create the face of curb at EP=CB1, and to create the inside top of curb (CB2). Because of the symmetry and consistency of the curb, only the back of curb needed to be surveyed to hold the existing curb feature in place within Process Road Design. From that survey, the 3D Polyline for the EP is derived, which will be used for Template Point Centerline and Template Point Profile.

Features such as curbs and medians can be designed once within Design Template and then saved as curb or median files, then re-loaded and used in other templates, and applied to the left or right side of the template as desired. The central rock median of 1’ total width can be constructed as two subgrades, one on the left side of 0.5’ width and one on the right side of 0.5’ width. The brick portion can be designed as a 4" thick subgrade as shown below. On the left side, you would need to use the "Straight Up" method of closing the subgrade surface. On the right side, you can use "Continue Slope". When using Continue Slope, it is best to underestimate the length needed to contact the next surface (the right curb), so continue can do an "extend" and find it. If you make the length too long (e.g. 6’, which catches the curb which itself tilts back -2%), the program will not trim and will draw the subgrade to the back of the curb. Note that the vertical subgrade depth can be entered as 4 or -4. Both are accepted.

Be sure to define the sand subgrade on the right side (lowest subgrade) to have a distance of EP, a flexible distance.
The next step is to set up the face of curb 3D polyline as a template point centerline and template point profile assigned to "EP". First you must do Polyline to Centerline File, pick the inner 3D polyline which is face of curb at proposed road level. Then you must do Profile from 3D Polyline and make a profile for the "EP". Then you assign this centerline and profile to the appropriate ID (EP) to force the curb to contact the correct curb position and elevation. The curb defined in the template matches the pattern of the in-place curb, so by setting EP to the correct template centerline and profile, the curb will "follow" at the correct position. The stationing used for the template point centerline is not critical to the calculation. However, the profile stationing much match and reference the centerline stationing. Therefore, when doing the command Profile from 3D Polyline, answer Yes to the question: "Station by another reference centerline [Yes/<No>]:". Making the Template Point Profile is always best accomplished by this method of Profile from 3D Polyline, referencing the design centerline. The Template Point Profile (and Template Point Centerline) would appear as shown here:

The files in Process Road Design would be set up as follows:
Note that no existing surface file is needed to compute final cross sections from as-built (straight wall on left of alley) to as-built (existing curb on right of alley). A final section is plotted below, showing the unique slope and lane distance determined by the as-built centerline and profile files that control the edge of pavement, and by extension, the curb, which continues with fixed dimensions from the edge of pavement.

A second method of doing as-built road design is to use the as-built cross section method. Whenever as-built cross sections are specified as part of the input files in Process Road Design, and then referenced for use on the Additional Road Design Parameters screen within Process Road, those offset IDs that are referenced will be held. Any matching IDs or new IDs found in the as-built cross sections will be substituted for the designed IDs within the final sections.

In the example below, it might be proposed to redesign Edgemont Road from a roadside ditch road to one with a curb and gutter as well as sidewalks. However, the designer might want to keep the existing central median, already curb and gutter with plantings.
This example raises the challenging issue of inserting special interior points with new IDs into a set of design cross sections, through a length of about 125 feet of road. If a cross section of the island is taken through station 1+00, it might have the following ID points:

This cross section could then be part of an as-built cross section file (.SCT) which can be recorded at any desired station interval, the smaller the interval, the greater the accuracy. Now if the actual road template is defined as EP for edge of pavement and standard CB for curb, with CENTER for the centerline position, Process Road Design will substitute the As-Built File CENTER ID for the one calculated by the program, and will add in all the unique IDs from the cross section file, from -15.011 left to 15 right. Interestingly enough, this Edgemont Road example would also require a Template Point Centerline for the left and right edge of pavement, to pull the paving edge out to the expanded road dimension, which doesn't taper to normal until station 3+35.51. It would not require a Template Point Profile, so long as the road maintained a consistent design slope from centerline. When using Template Point Centerline, you need to turn the edge of pavement polylines into centerline files. Before doing so, test each polyline.
with the command Reverse Polyline (within Polyline Utilities under Edit) to verify that the polyline is drawn in the correct direction, as shown by the phantom arrows. The file Template Point Centerline elements might appear as shown:

![Define Template Alignments](image1)

Be aware that a subgrade such as a concrete sidewalk, if it is to be placed behind the curb, must reference the curb or the edge of pavement ID for positioning, whenever the edge of pavement offset is changing based on use of a Template Point Centerline or As-Built cross section file containing duplicated IDs for edge of pavement. You can specify an offset for the sidewalk in the Subgrade option within Design Template, as shown below. The "2.52" offset was used to move past the tilting edge of the back-of-curb, which slightly exceeds 2.50.

![Sub Grade Dimensions](image2)

If the Island.sct file is the as-built cross sections, the entire input screen for the Edgemont Road project might appear as follows:
In the next dialog, fill in the descriptions for the section points in the As-Built IDs To Use field.

Here is the resulting output section file showing the combination of the design template with the as-built section points.
Example Divided Highway with Special Super Elevation Treatment

Divided highways such as 4-lane highways with a central depressed, grassy median are among the most challenging roads to define as templates, especially when accurate subgrade elevations and quantities are involved. Rules for superelevation and subgrade pivot points must be applied. And most divided highways do not use the centerline as the profile and require shifting the profile elevation to a specific template ID, like the inside edge of pavement or crown point for each side of the highway. This shifting occurs within Process Road Design. Furthermore, many highway departments have complicated rules for the profile grade. One such rule is that in superelevation, when the pivot lane reaches reverse crown, the profile moves from the crown of the road to the inside edge of pavement. Whatever the delta Z between the crown profile grade and inside edge of pavement profile grade is at reverse crown, this delta Z is subtracted from the profile grade and determines the profile of the inside edge of pavement from reverse crown through full super and back to reverse crown again. This typically improves drainage within the median portion, since a steep superelevation pivoting from the crown of the road can either reduce the median depth, or force the median too low. This is illustrated in the graphic below. Such challenging highways can be designed using special features within Design Template and Process Road Design.

The divided highway template itself can be quite complex. Let's review the requirements of our template below, first left side, then right side, in superelevation of 4.5%. 

![Diagram showing divided highway template with special super elevation treatment.](image-url)
The main criteria for the design is that the pavement lanes are 12' wide, with 2% slope from the crown point in the middle (except in superelevation). On the interior high side of superelevation shown above, the grade breaks off at the EP or inside edge of pavement, and the maximum algebraic difference is 7%. So at 4.5% superelevation, the normal 4% downhill shoulder slopes instead at $7\%-4.5\%=2.5\%$, as shown. This part of the template behavior is controlled by the Superelevation Shoulder button within Design Template, with entries as shown here:

![Super Elevation Settings dialog](image)

Note that the Super Elevation Settings dialog treats the "interior" of the road in the upper part, and the exterior of the entire road (like a 2-lane road) in the lower part. So the "Low Side Pivot Point" under the lower "Transition from Super to Normal" is where, walking from the middle of the road towards the left, super ends and normal slopes resume. That is set to OSH, or the outside shoulder position, the goal being to slope the full shoulder with the superelevation on the lower outside shoulder lane, then resume normal (non-super) slope at the 6:1 "recovery zone" slope. The entry of OSH as Low Side Pivot Point for Super to Normal controls that. In the upper part of the dialog, the inside "Transition from Normal to Super" sets the Low Side Pivot Point at EP. So at EP, walking from the template center left towards the left side of the road, normal ends at EP and superelevation begins. So the median upslope of 6:1 is normal, as is the shoulder, the super starts at EP. But because the 7% maximum percent slope difference is active, the shoulder can't remain at 4% but goes to 2.5% leading to the 4.5% superelevation. When super subsides to 3% or less, the shoulder would be normal at 4% as specified in the template design in this case.

Referring to the graphic above showing the left side of the divided highway, the gravel for the shoulder is shown running out to "daylight" on the outside recovery zone and on the inside median slope. However, to reduce quantities of stone, the stone runs at a uniform slope of -2% in normal crown, or matches superelevation, but pivots to 1% downhill at the outside OEP and 4' past the inside EP. This is accomplished through the subgrade entry dialog. First, the outside subgrade:

---

*Chapter 6. Civil Module*
Note that the normal slope of the stone subgrade does not follow the surface but stays at the "special" slope of -2%, matching the surface always only beneath the asphalt portion within the pavement zone. For divided highways, it is always necessary to do at least 2 subgrades for each material: one from the crown or middle of the road "out" to the outslope (as above), and one from the crown or middle of the paved portion in to the interior. Since the crown of the road on each side of the highway is 32 feet left of the center depressed median position, the horizontal offset for the "out" position is 32. Enter the vertical offset as the entire distance from the horizontal offset down to subgrade bottom. In this way, any other thinner subgrades above are deducted from total subgrade quantities of the grade under consideration. If the goal is to "force" a -1% slope in both normal crown and superelevation, then set the Max Slope After Pivot(%) to -1%, and click "Special". Then set both Standard Slope and Minimum Slope Percent to -1%. This ensure that -1% will be used at the pivot offset of OEP, or as specified. Apply this to both subgrades ("in" and "out" from horizontal offset 32). If you simply entered -1% for the Max Slope After Pivot(%) and clicked Normal, slopes on the low side would break over to -1% but slopes on the higher side of each superelevation lane (beneath inside shoulder on the left, outside shoulder on the right) would continue on at the super slope and not break off. You must use the "Special" setting. The low side shoulder for the inside portion of the left side of the road is specified by the "In" subgrade, in this dialog:
The pivot point for the subgrade on the inside left of the template is ISH+4, or 4 feet from inside shoulder to inside edge of pavement, the +4 being the direction walking out from the middle of the template in all cases. The right side of the template is shown next:

On the right side, the high-side subgrade pivot in the "out" direction, walking from the middle of the road outward, is OEP+4. On the right side, the high-side subgrade pivot in the "in" direction is simply ISH, as shown. So the controls exist to specify critical break points on subgrade and surface grades using Design Template. Whether this is the best design can be debated, but the controls are there to create surface and subgrade slope breaks and grade changes.

Referring to the Super Elevation Settings dialog above, the key to setting the superelevation of the divided highway to the inside edge of pavement at reverse crown (minus the 0.24 delta Z from profile grade to inside edge of pavement grade) is to click on the option, "Pivot Super From Low Edge".

Now you must run Process Road Design, using this template, to produce verifiable final cross sections. Set the Process Road "Additional Parameters" dialog such that "Crown" (or whatever ID is used for the center crown point on each side of the road) controls the profile grade.
The final sections that are produced will shift the profile grade to the inside edge of pavement from reverse crown to reverse crown through superelevation, adjusted -0.24'. A final section is shown plotted below as drawn using Draw Section File:

Pulldown Menu Location: Roads  
Keyboard Command: eeworks  
Prerequisite: Profile file and template file

Road Network
This command synthesizes road network design for subdivisions and commercial and industrial sites by enabling interactive 3D design of all road centerlines, profiles and templates, including cul-de-sacs. A docked dialog on the left of the screen identifying the existing DTM surface and all road files combines with an active CAD screen and command line. You can save drawings and run virtually any standard Autocad command while within the docked dialog. Once the user identifies all centerlines involved, the program detects intersections and end segments suitable for cul-de-sacs, and through user input of design parameters for cul-de-sac dimensions and intersection transitions, the program will process the complete 3D design, with output options including cross sections, 3D faces, TIN files and contours. The many roading files involved in a road network design are all saved to an "RDN" file that can be recalled, modified and re-processed.

This Road Network Help document is divided into 7 parts: Road Network Task Pane, Road Network Settings, Adding and Editing Roads, Road Network Road Profile Editor, Adding and Editing Intersections, Adding and Editing Cul de Sacs, Road Network Workflow Example #1 and Road network Workflow Example #2

When designing roads using Carlson’s Road Network feature, all work is done through a Task Pane that docks along the left side of the drawing screen. Having the Task Pane open and active does not prohibit or interfere with normal Command: line or other CAD functionality.

All settings and files associated with a roadway design project are saved in the Road Network (.RDN) file. Upon starting the Road Network command, the user is prompted to open an existing or create a new Road Network
Once Roads, Intersections and Cul-de-Sacs have been added to the Road Network, selecting any one of them in the Task Pane highlights the feature and centers it in the drawing screen. Highlighting and centering options may be changed in the Display Options tab of the Road Network Settings dialog box.

Add: Pick this button to Add a Road to the Network. After adding the Road, the Edit Road dialog box is displayed allowing the user to manage and make changes to the Input Files and Output Files for the selected Road.

Edit: Pick this button to display the Edit Road dialog box to manage and make changes to the Input Files and Output Files for the selected Road.

Remove: Pick this button to delete the selected Road from the Road Network. After Removing the Road from the Network the design files associated with that Road will remain in the project folder.

This area of the Task Pane lists the Intersections within the Road Network. Intersections are created automatically as intersecting Roads are added to the Network. See Road Network: Adding and Editing Intersections for additional assistance.

Edit: Use this button to display the Edit Intersection dialog box and make changes to the Input Data and Output Files for the selected Intersection. Other changes that can be made to the Intersection design are:

1) Changing the Primary/Secondary status of the Roads creating the Intersection,
2) Making design changes that apply to the entire Intersection,
3) Making design changes that apply to one or more Corners of the Intersection.
Reset: Use this button to overwrite all design changes made to the selected Intersection and reset to the original Intersection design.

This area of the Task Pane lists the Cul-de-Sacs defined as part of the Road Network. See Road Network: Adding and Editing Cul-de-Sacs for additional assistance.

Add: Picking this button will display a list of Roads in the Network and prompt the user to "Select Road for Cul-de-Sac"... After selecting the Road, the Edit Cul-de-Sac dialog box is displayed allowing the user to specify the Input Data and Output Files for the Cul-de-Sac.

Edit: Use this button to display the Edit Cul-de-Sac dialog box and make changes to the input data and output files for the selected Cul-de-Sac.

Remove: Use this button to Remove the selected Cul-de-Sac from the Road.

Process: Use this button to manually trigger the computation process for the Road Network and perform the tasks configured in the Output Options tab of the Road Network Settings dialog box.

Report: Use this button to Save or Print one of two Reports provided by the Road Network feature which are: the Output Processing report and the Input Data Files report. Default Report settings can be changed in the Report Options tab of the Road Network Settings dialog box.

The Output Processing Report displays the cut/fill and material quantities for each Road, Intersection and Cul-de-Sac of the Road Network.

Road Network Output Processing Report

The Input Data Files Report displays all of the user-specified design files associated with the Road Network. The user has the option of reporting only the filename or both the path and filename.
Road Network Input Data Files Report

Settings: This button displays the Road Network Settings dialog box which is the starting place for all projects designed using the Road Network feature. There are 5 tabs in the dialog box: Process Options, Output Options, Report Options, Display Options and Transition Defaults.

Save: Pick this button to Save the Road Network (.RDN) file.

SaveAs: Pick this button to Save the current Road Network (.RDN) file and give it a new path and/or filename.

Load/New: Pick this button to Load an existing or start a New Road Network (.RDN) file.

Exit: Pick this button to Exit the Road Network command and close the Task Pane.

The Road Network Settings dialog box is accessible from the Settings button on the Road Network: Task Pane.

Settings Button of the Road Network Task Pane

The Road Network Settings dialog box is the starting place for all projects designed using the Road Network feature. There are 5 tabs in the dialog box: Process Options, Output Options, Report Options, Display Options and Transition Defaults.
Process Options Tab

**Existing Surface**: Use this button to browse to and select the Existing Surface file to be used for the Road Network. Either a TIN or FLT triangulation file are accepted as valid surfaces, both of which can be made within the command Triangulate and Contour. For speed, it is recommended that the binary TIN file format be selected.

**Rock Surface**: Use this button to set the Rock Surface file to be used for the Road Network. This Rock Surface is optional. When the Rock surface is specified, the program will report rock quantities with the cut. Also, the cut definition in the road template file can have a separate slope to the rock surface.

**Station Interval**: These settings determine the distance between cross-section samples. The user has the option of specifying one sampling interval for the Intersection and another for the remainder of the Road.

**Existing Section Max Offset**: Use this setting to specify the furthest distance left and right of the Centerline that cross-sections are to be sampled.

**Special Stations**: This button displays the Stations to Process dialog box (shown above). This box allows the user to decide whether or not cross-sections are to be sampled at critical design points along each Centerline.
Stations include critical points such as the PC & PT for Centerlines and the PVC, PVT, High Point and Low Point for Profiles. "Additional Special Stations" may be added by entering the station number. These settings apply to all Roads in the Road Network. To identify Special Stations for a particular Road, pick the Special Stations button in the Edit Road dialog box.

Process On Updated Design Files: This setting has 3 options: Off, Prompt and Auto:
Off: This option allows changes to the design files without triggering an automatic update to the entire Road Network.
Prompt: This option automatically prompts the user, "Process Road Network?" when design files are changed.
Auto: This option automatically updates the Road Network any time a design file is changed.

Prompt to Process Updated Road Network Design

Slope Perpendicular To: This setting allows the user to specify the direction of cut and fill slope projection by selecting one of two options: Centerline and Slope Direction. The Centerline method projects the cut and fill slopes perpendicular to the Centerline of the Road without regard to the Profile of the Road. The Slope Direction method considers the Profile of the Road when projecting the specified cut and fill slopes. For example, projecting cut and fill slopes of 2:1, perpendicular to the Centerline, along a length of Road with a Profile slope of 10% would result in a slightly steeper slope (1.96:1) if measured along the top or toe of that slope. If the same conditions exist but the Slope Direction method is applied, the resulting slope (when measured perpendicular to the Centerline) is slightly less steep (2.04:1) but when measured along the top or toe of slope will be exactly 2:1.

Tie to Existing: If enabled and cut and fill slopes have been defined in the Template (.TPL) file, this setting will project the specified slopes to the Existing Ground surface. If not enabled, the Road design will stop at the last Template ID preceding the cut and fill slopes.

Process Intersections: If enabled this option will calculate all Roads and Intersections. If it is not enabled, each Road will be processed individually.

Connect Roads: This option applies to the 3D polylines/breaklines that are created when Processing the Road Network. If this option is enabled, the 3D polylines for different Roads will be combined around and through Intersections. If it is not enabled, the polylines will be drawn for each Road separately.
Triangulate and Contour: When enabled, use the Setup button to display the Triangulate and Contour From Road Network dialog box. Since this command is very similar to the Surfaces → Triangulate and Contour command, only those Settings and Options directly affecting the Road Network will be discussed here. Please refer to the Help files for that command if additional assistance is needed.

In the Triangulate and Contour From Road Network dialog box...

Triangulate tab

Draw Triangulation Faces: The Road Network version of this command provides additional controls (beyond those in the standard Triangulate and Contour command) for managing the color of the "Triangulation Faces". Once the "Triangulation Faces" option is enabled, the Set Colors/Layers button becomes active and, when picked, will display the Road Color Settings dialog box (shown below). The color of the faces can be set either by using the Template IDs defined in the Template (.TPL) file or using a color range based on the "Cut & Fill Depths" that uses a range of Reds and Blues to show areas and depths of Cut and Fill for the proposed Road Network. After the Road Network has been Processed, these shaded faces can be viewed using the 3D Viewer Window command. Also within Triangulate & Contour, there is Draw Slope Arrows to create arrows in the drawing to show the direction of each triangular "plate" in the Road Network TIN. This can be helpful to visualize where water will be flowing.

Write Triangulation File: Once enabled, use the Browse button to specify the path and filename for the roadway design Surface (.TIN) file.
Set Road Colors In the "Triangulate and Contour From Road Network" Dialog Box

Contour and Labels tabs...
Use these tabs to define the settings for proposed contours and contour labels.

Output Options (Continued)

Merge Road with Existing: When enabled, use the Set button to specify the path and filename of a third Surface (.TIN) file to be created by merging the Existing and roadway design Surface (.TIN) files.

Write SurvCE Stakeout: When enabled, use the Set button to specify the path and filename of a SurvCE Stakeout (.RNF) file to be exported. This file can be directly loaded into data collectors using Carlson SurvCE for unlimited field stakeout of the Road Network.

Draw Template Polylines: When enabled, this option will draw all 3D polylines used to generate the roadway design Surface. This option is automatically enabled when the Triangulate and Contour option is enabled. The layer for the polylines is set by picking the Set Layers button in Output Options.

Draw Disturbed Area: When enabled, this option will draw a closed, zero-elevation polyline around the limits of disturbance of the roadway design Surface. The layer for the polyline is set by picking the Set Layers button in Output Options.

Draw Subgrade Polylines: When enabled, this option will draw all 3D polylines used to generate the roadway subgrade Surface(s). These polylines can be used to manually generate additional surfaces for modeling, stakeout or machine control purposes. Entering an asterisk (*) in the text box will draw polylines for all Template IDs. Once a Road has been added to the Network, the Select button will be activated. Picking the Select button displays a view of the Template (.TPL) file at the starting station and allows the user to Draw polylines for selected Subgrade IDs. If needed, the Next and Previous buttons at the bottom of the window allow the user to browse through the stations of the road design to find a particular Subgrade ID. The layer for the polylines is set by picking the Set Layers button in Output Options.
Pick Subgrade Polylines to Be Drawn

**Draw Template Slopes:** When enabled, this option will draw slope arrows parallel to the Centerline at the selected Template IDs. This option may be used to indicate direction and steepness of slope along the flowline of the gutter. Entering an asterisk (*) in the text box will draw slope arrows for all Template IDs. Once a Road has been added to the Network, the **Select** button will be activated. Picking the **Select** button displays a view of the Template (.TPL) file (similar to the one shown above) and allows the user to **Draw** polylines for selected Template IDs. If needed, the **Next** and **Previous** buttons at the bottom of the window allow the user to browse through the stations of the road design to find a particular Template ID. The layer for the slope arrows is set by picking the **Set Layers** button in **Output Options.** Other slope arrow settings are specified by picking the **Set Slopes** button in **Output Options.**

**Draw Cross Section Polylines:** When enabled, this option will draw a 3D polyline defining the roadway design surface cross-section at each sampled station along the Centerline. These polylines can be used to manually generate additional surfaces for modeling, stakeout or machine control purposes. The layer for the polylines is set by picking the **Set Layers** button in **Output Options.**

**Draw Cut/Fill Arrows:** When enabled, this option will draw arrows at each sampled cross-section station so that the arrow is pointing down-slope. The example shown below indicates a section of Cut slope transitioning to a section of Fill slope. Once enabled, the user has the ability to adjust the size of the arrows and specify whether or not the Cut/Fill Arrows should be solid.

---

**Cut/Fill Arrows On Slopes**
**Label Profile on Centerline**: When enabled, this option labels Profile slopes and critical points such as PVC, PVT, High and Low Points in plan view along the Centerline. Once enabled, use the **Setup** button to open the **Label Profile on Centerline Settings** dialog. Then, from the list of "Available Labels", select the label(s) to be drawn and use the **Add** button to shift them to the list of "Used Labels". Selecting one of the "Used Labels" and then picking the **Setup** button allows the user to configure the label style and settings for each type of label.

![Label Profile on Centerline Settings](image)

**Label Profile on Centerline and Label Setup Dialog Boxes**

**Output Coordinates**: When enabled, this option allows the user to export a Coordinate (.CRD) file containing all of the critical points for the Road Network. Once enabled, pick the **Setup** button to specify the path, filename and other criteria for the point file.

![Output Coordinates](image)

**Point Output Settings Dialog Box**
Output EOP Profiles: When enabled, this option creates individual Profile (.PRO) files for the edges of pavement.

Output EOP Profiles Dialog Box

Elevate Pads: When enabled, this option adjusts the elevation of closed polylines within a specified proximity of the Road Network. Once enabled, use the Setup button to open the Elevate Pad Settings dialog box and configure the settings.

In the Elevate Pad Settings dialog box...

Reference Template ID: When determining the new pad elevation, all distances and elevation changes are based on the Template ID specified here. Type the Template ID in the text box or use the Select button to choose from a list.
Pad Layer: All original polylines found on this layer (and within the Max Offset of the Reference Template ID) will be elevated.
Max Offset: All original polylines within this distance of the Reference Template ID and on the specified "Pad Layer" will be elevated.
Reference Elevation: This setting has 3 options: "Highest Elevation", "Lowest Elevation" and "Elevation at Middle". Of the elevations found along the Reference Template ID that are adjacent to the pad polyline, the command will use either the highest, lowest or middle elevation found to set the new pad elevation.
Slope Type: This setting has 3 options: Percent (%), Ratio (x:y) and Vertical (change in elevation).
Cut/Fill, Normal/Min/Max Slopes: For future earthwork balancing adjustments, the settings in this dialog are used to specify the range of allowable slopes when in cut or fill conditions.
Assign New Layer: When enabled, this option allows the user to specify a new layer for the new, elevated pad polyline. Once enabled, either type the new layer name in the text box or use the Select button to choose the layer from a list.
Retain Original Polyline: This option is only available if the "Assign New Layer" option is enabled and will keep the original, zero-elevation polyline in addition to the new, elevated polyline. If this option is not enabled, the original polyline will be deleted from the drawing.
Elevate Pad Settings Dialog Box

In the dialog shown here, all closed polylines on layer PAD that are within 100 feet of the road will have their elevations set based on a 2 percent grade up from the PAVE Template ID point, in either Cut or Fill conditions. In future earthwork balancing adjustments, the polyline can be adjusted a maximum of up to a 10 percent grade or down to a 1 percent grade from the Reference Template ID. The example below shows the results of elevating a pad so that it is 2.0' above (using Vertical option) the highest point along a Reference Template ID of "SH" (Shoulder) on the adjacent Road.
Output Options (Continued)

**Elevate Lots**: When enabled, this option follows a logic similar to that of the **Elevate Pads** routine in that it elevates zero-elevation lot lines relative to a road design and based on a set of grading rules. Once the option is enabled, use the **Setup** button to display the **Elevate Lots Setup** dialog box.

*In the Elevate Lots Setup dialog box...*

**Grading Rules**: The necessity of a Grading Rules (.GRR) file is the key difference between elevating pads and elevating lots. If a Grading Rules (.GRR) file has already been prepared, use the **Select** button to browse to and select the file. To create a new file, pick the **Edit** button to open the **Define Grading Rules** dialog box and specify the desired settings. Then, pick the **SaveAs** button to **Save** a Grading Rules (.GRR) file. **Define Grading Rules** is a command that also exists outside of the **Road Network** feature. Please refer to the **Help** files for that command if additional assistance is needed.

**Reference Template ID**: When determining the elevations for the new lot line, all distances and elevation changes are based on the **Template ID** specified here. Type the **Template ID** in the text box or use the **Select** button to choose from a list.

**Input 2D Lot Layer**: All original polylines found on this layer (and within the Max Offset of the Reference Template ID) will be elevated. Either type the layer name in the text box or use the **Select** button to choose the layer name.

**Output 3D Lot Layer**: This is the layer to which the newly elevated lot lines will be assigned. Either type the layer name in the text box or use the **Select** button to choose the layer name.

**Front to Ref Max Offset**: Use this setting to specify a distance from the **Reference Template ID** beyond which Lot Frontage polylines will not be elevated.

**Back to Ref Max Offset**: Use this setting to specify a distance from the **Reference Template ID** beyond which Back/Rear Lot polylines will not be elevated.

---

![Elevate Lots and Define Grading Rules Dialog Boxes](image)

**Output Options (Continued)**

**Set Layers**: Pick this button to display the **Road Network Layers** dialog box.
**Road Network Layers Dialog Box**

*Set Slopes:* Pick this button to display the **Road Network Slopes** dialog box and configure the settings for drawing slope arrows.

**Road Network Slopes Dialog Box**

*Output File Defaults:* Pick this button to specify additional Centerline (.CL), Profile (.PRO) and Section (.SCT) files to be saved when Processing the Road Network.

**Output File Defaults Dialog Box**

Settings on this tab allow the user to specify defaults for the Road Network **Report** feature. This feature is...
accessible from the Report button of the Road Network: Task Pane.

**Report Precision:** Specify the decimal precision for the report.

**Use Report Formatter:** This option allows for customized report layout and contents. Otherwise a standard report is displayed.

**Report Cut/Fill End Areas:** Specify whether or not to report cut/fill at each station.

**Report Cut/Fill Differences:** Adds a running total of the cut to fill balance at each station to the report.

**Report Cumulative Cut/Fill:** Adds a running total of the cut/fill at each station to the report.

**Fill Shrink/Cut Swell Factor:** Allows you to specify a value that the volume calculated will be multiplied by.

**Report Options Tab**

Settings on this tab allow the user to configure special display characteristics in order to identify the Road, Intersection or Cul-de-Sac selected in the Road Network: Task Pane.

**Display Options Tab**

Settings in this tab allow the user to specify the default values used for transitioning from Road to Road, from Road to Intersection and from Road to Cul-de-Sac.

**CL Intersections:** Use this setting to define the default transition distance and vertical curve length for intersecting Centerlines. See Road Network: Adding and Editing Intersections for more.

**Side Intersections:** Use this setting to define the default vertical curve length for the Profile and the default radius for Corners at Intersections. See Road Network: Adding and Editing Intersections for more.

**Surface Method:** When calculating Intersections, there are two options for handling the cross-sections of the intersecting Roads: "Hold Main Crown", which honors the Primary Road Template through the Intersection, or "Radial from Curb", which grades between the Centerline Profile and the Profile of each Corner of the Intersection. The Profile for the Corner may be defined as the edge of pavement (EP), back of curb (BC) or other point on the cross-section by specifying the Template ID in the Settings tab of the Edit Intersection dialog box.
Surface Method: Radial From Curb

Surface Method: Hold Main Crown

**Transition Method**: This setting applies when a Road has a varying width through an Intersection. The "Across Intersection" option looks at the Primary Road (from start to end of the Intersection) to find the maximum offset distance between the Centerline and edge of pavement, and uses this distance to set the edge of pavement breakline across the Intersection with the Secondary Road. The "Mid Point" option simply finds the pavement width at the Intersection station and uses this distance to set the edge of pavement breakline across the Intersection.

**Cul-de-Sac**: Use this setting to define the default vertical curve length along the Cul-de-Sac Profile.

---

### Transition Defaults Tab

Roads in a Road Network are managed in the **Road Name** area of the **Road Network: Task Pane**.

**Add**: Pick this button to **Add** a Road to the Network. After adding the Road, the **Edit Road** dialog box is displayed allowing the user to manage and make changes to the **Input Files** and **Output Files** for the selected Road.

**Edit**: Pick this button to display the **Edit Road** dialog box to manage and make changes to the **Input Files** and **Output Files** for the selected Road.

**Remove**: Pick this button to delete the selected Road from the Road Network. After Removing the Road from the Network the design files associated with that Road will remain in the project folder.
Adding a new Road may be done either by selecting a pre-defined Centerline (.CL) file or by screen-picking a 2D Polyline in the drawing and assigning a new Centerline (.CL) file to it.

**Road Name Area of the Road Network Task Pane**

**Add**: Use this button to **Add** a Road to the Road Network. After picking the **Add** button, the **Add Road** dialog box gives the user the option to "Select Centerline By..." **Centerline File** or **Screen Pick Polyline**. If the **Centerline File** option is chosen, the user is prompted to browse to and select the Centerline (.CL) file.

**Specify Method to Use to Add Road**

If the **Screen Pick Polyline** option is chosen, the user is prompted to select a polyline in the drawing. If an associated Centerline (.CL) file is not found in the project folder, the **Set Centerline** dialog notifies the user that, "No centerline file associated with polyline..." and the user must choose to either select another polyline or to **Assign Centerline File to Polyline**.

**Set Centerline Dialog Box**

After picking the **Assign Centerline File to Polyline** button, the **Centerline to Set** file dialog box prompts the user to assign a path and filename for the new Centerline (.CL) file.
Centerline to Set File Dialog Box

Immediately upon defining the new Road, the **Profile to Use** file dialog box prompts the user to assign a path and filename for the proposed Profile (.PRO) file for the Road. By default, the new Profile (.PRO) file is named the same as the Centerline (.CL) file.

Profile to Use File Dialog Box

After specifying the Centerline (.CL) and Profile (.PRO) files for the Road, the **Edit Road** dialog box is displayed. This dialog serves as the "manager" for all files relating to the specific Road. The **Edit Road** dialog box allows the user to apply settings and associate various files that are specific to the Road - not the entire Road Network. The **Edit** button in the **Road Name** section of the **Road Network: Task Pane** also displays this dialog box.
Edit Road Dialog Box

**Intersection Only**: If this option is enabled, Road Network will only consider the portions of this Road that intersect with other Roads when calculating the design.

**Station Settings**: Pick this button to display for special stations and cut/fill gaps.

**Special Stations**: Enter one or more stations at which to sample cross-sections.

**Cut/Fill Gaps**: Use the Add and Remove buttons to define a series of station ranges for cut/fill gaps where the program will not calculate any volumes or apply the template cut/fill tie slopes. For example, these stations could be used across a bridge.

---

Add Road Specific Special Stations

A Centerline (.CL) file, a Profile (.PRO) file and a Template (.TPL) File are **required** in order to process a roadway design using the Road Network feature. In addition, the Road Network feature accepts several additional files.
for designing Roads using specific criteria. In the Edit Road dialog box, picking the buttons on the left, that are labeled with the file type, will display a file dialog box prompting the user to select an existing or create a new file of that type. The corresponding Edit button to the right of each file type will display the editor for that file type.

Required Road Input Files

Centerline: Pick this button to select an existing or create a new Centerline (.CL) file from which to define the horizontal alignment of the Road. The Edit button opens the Centerline File Editor. This Editor is the same as the one used for the Input-Edit Centerline File command. Please refer to the Help files for that command if additional assistance is needed.

Centerline File Editor

Profile: Pick this button to select an existing or create a new design Profile (.PRO) file for the Road. The Edit button opens the Input-Edit Road Profile Editor. The Editor provides the user with both a "profile-grid-view" and a "table-view" of the Profile (.PRO) file. See Road Network: Road Profile Editor for more.
**Input-Edit Road Profile Editor**

**Template**: Pick this button to select an existing or create a new Template (.TPL) file or Template Series (.TSF) file for the Road.

A Template (.TPL) file defines a typical roadway cross-section including pavement, curb, ditches, medians, super-elevations, subgrades, rights-of-way and cut/fill slopes. One of the most critical steps in defining a Road Template for use with the Road Network feature is the assigning of a **Template ID** to points on the Template. A **Template ID** is a unique name for each point on the Template and is used to transition from Road to Road, from Road to Intersection and Road to Cul-de-Sac. The **Template ID** serves 4 purposes: (1) the ID will be applied as a description to all final Template points generated in the form of a Coordinate (.CRD) file, (2) the ID can be used as a design point in the Template definition, as in EP+5 indicating 5 feet or meters right of edge of pavement, (3) points of common ID may be connected by 3D polylines in the **Output Options** tab of the Road Network: Settings dialog box and (4) Quantities can be generated with reference to the ID and material (gravel, concrete, etc.) also defined in the Template (.TPL) file.

A Template Series (.TSF) file references Template (.TPL) files for Template-to-Template transitioning and is one method used for widening and narrowing of Road sections.

Picking the **Edit** button will open the appropriate **Design Template** or **Input-Edit Template Series File Editor**. These Editors are the same as those used for the **Draw Typical Template** and **Template Transition** commands. Please refer to the **Help** files for those commands if additional assistance is needed.
Optional Road Input Files

Super Elevation: Pick this button to select an existing or create a new SuperElevation (.SUP) file for the Road. The Edit button opens the Super Elevation Editor. This Editor is the same as the one used for the Input-Edit Super Elevation command. Please refer to the Help files for that command if additional assistance is needed.
Input-Edit Super Elevation

**Topsoil Removal**: Pick this button to select an existing or create a new Topsoil Removal (.TOP) file for the Road. This file allows the user to define topsoil removal and replacement zones to be used in the Road design. Different topsoil depths can be used for different station ranges and then are computed as part of the cut and fill volumes. The **Edit** button opens the **Topsoil File** Editor. This Editor is the same as the one used for the **Topsoil Removal/Replacement** command. Please refer to the **Help** files for that command if additional assistance is needed.

**Topsoil Removal/Replacement Editor**

**Template Transition**: Pick this button to select an existing or create a new Template Transition (.TPT) file for the Road. This file allows the user to define changes in grade distances or slopes for a specific Template ID through a range of stations and is another method of widening and narrowing Road sections. The **Edit** button opens the **Template Transition** Editor. This Editor is the same as the one used for the **Template Transition** command. Please refer to the **Help** files for that command if additional assistance is needed.
Template Transition Editor

**Template Grade Table**: Pick this button to select an existing or create a new Template Grade Table (.TGT) file for the Road. This file allows the user to define specific slopes and distances for one or more Template IDs (and for left and right sides independently) that have been assigned in the Template (.TPL) file. The **Edit** button opens the **Template Grade Table** Editor. This Editor is the same as the one used for the **Template Grade Table** command. Please refer to the **Help** files for that command if additional assistance is needed.

**Template Pt Profile**: Pick this button to select an existing or create a new Template Point Profile (.TPP) file for the Road. This file allows the user to assign separate Profile (.PRO) files to specific Template IDs that have been defined in the Template (.TPL) file. This accommodates varying grade changes (for a ditch, for instance) independent of the Profile for the Centerline. The **Edit** button opens **Define Template Alignments** and then picking the **Add** button displays the **Template Point Profile Settings** dialog box. These dialog boxes are the same as the ones used for the **Assign Template Pt Profile** command. Please refer to the **Help** files for that command if additional assistance is needed.
Assign Template Pt Profile Dialog Boxes

Template Pt Centerline: Pick this button to select an existing or create a new Template Point Centerline (.TPC) file for the Road. This file allows the user to assign separate Centerline (.CL) files to specific Template IDs that have been defined in the Template (.TPL) file. This accommodates varying widths for cross-section surfaces and provides an additional method of managing widening and narrowing of Roads. The Edit button opens Define Template Alignments and then picking the Add button displays the Template Point Centerline Settings dialog box. These boxes are the same as the ones used for the Assign Template Pt Centerline command. Please refer to the Help files for that command if additional assistance is needed.

Assign Template Pt Centerline Dialog Boxes

Road Design Parameters: Pick this button to select an existing or create a new Road Design Parameters (.RDP) file for the Road. This file allows the user to define a set of Road design standards to compare against a roadway design. The Road Network Process function will report a warning when the design is out of compliance with these parameters. The Road Design Parameters can be specific to all stations along a Road or, in the event speed limit or other changes must be applied, a range of stations. The Edit button opens the Road Design Parameters dialog box. This box is the same as the one used for the Define Road Design Parameters command. Please refer to the Help files for that command if additional assistance is needed.
Road Design Parameters Dialog Box

Cut Benches: Pick this button to specify up to 4 triangulation surface files to use when the "Slopes In Series" and "Cut to Surface" options are used in the Template (.TPL) file. In cut conditions, the program will look to intersect with these surfaces before it reaches the final target surface which is the Existing Surface set under Settings.

Optional Road Output Files

Existing Section File: Pick this button to specify the path and filename for the existing cross-section file to be written. The default filename is set by picking Output File Defaults button in the Output Options tab of the Road Network Settings dialog box.

Final Section File: Pick this button to specify the path and filename for the final/design cross-section file to be written. The default filename is set by picking Output File Defaults button in the Output Options tab of the Road Network Settings dialog box.

SuperElevation Diagram: Pick this button to specify the path and filename for the SuperElevation Diagram (.SUD) file to be written.

The Input-Edit Road Profile Editor is accessible from the Edit Road Dialog box.
In Carlson’s Road Network feature, the initial design Profile is automatically generated and has only a starting and ending PVI - with the elevation at both ends tying into existing ground. The crosshairs are locked to the design Profile.

The initial PVIs can be seen in the profile-grid-view where the existing ground Profile is shown in red and the design Profile in white. The initial PVIs are shown in the table-view with the “PVI Description” indicating the PVI elevation is tied to the “TARGET-SURFACE” (existing ground).

The buttons and settings directly below the profile-grid-view allow the user to edit the Profile and adjust the Zoom and Scale factors of the profile-grid-view. The Insert PVI, Remove PVI and Screen Pick PVI buttons at the bottom of the dialog box allow the user to make changes to the Profile using the table-view.

**Input-Edit Road Profile Editor**

The profile-grid-view provides the user with a dynamic viewer and editor. As the crosshairs move along the design Profile, a "station" symbol on the drawing screen indicates the corresponding position/station along the Centerline. Also, as the crosshairs move along the Profile, the current Station, Elevation, Slope and Depth (between design and existing ground Profiles) are displayed and dynamically updated at the top of the window. The starting and ending stations for the Centerline are displayed above the buttons at the bottom of the window.
Pan, Zoom and Zoom Extents: Use these buttons to change the Zoom factor in the profile-grid-view.

Add PVI: Use this button to "screen pick" the location for a new PVI in the profile-grid-view. After screen picking the new PVI location, the New PVI box prompts the user to provide additional design criteria to set the new PVI.

New PVI Dialog Box

Edit PVI and PVI Edit Mode: Use the Edit PVI button to change the elevation and station of a PVI in the profile-grid-view by dragging-and-dropping it to a new location. The default PVI Edit Mode is "Free" which allows 360-degree motion when dragging-and-dropping the PVI. Other PVI Edit Mode options are: Hold Slope In, Hold Slope Out, Hold Station and Hold Elevation. The user also can choose to Hold Vertical Curve Length, Hold K-Value or Hold Sight Distance when editing the PVI using drag-and-drop. This setting is controlled in the Road Profile Settings dialog box.
**Vertical Exag:** Use this setting to "Fit" the Profile into the profile-grid-view area of the window or use other pre-defined options such as "x1", "x2", "x5" and "x10" to exaggerate the vertical scale by 1-, 2-, 5- or 10-times.

**Sag-Crest Points:** After adding one or more vertical curves to the design Profile, a list of the "sag" and "crest" points along the Profile will be listed in the drop-down box.

**Through Point:** After selecting a PVI in the table-view, pick this button to force a sag or crest point to a specific station and elevation.

**Check Station:** To find the precise Elevation, Slope and Reference Elevation (existing ground) for a specific station, enter the station in the text box and press Enter.

**Insert PVI:** Before picking the Insert PVI button, the user must use the mouse to select/highlight a cell in the profile table-view. Then, picking the Insert PVI button will create a blank row, above the selected row, allowing the user to enter the information for the new PVI.

**Remove PVI:** Before picking the Remove PVI button, the user must use the mouse to select/highlight a cell in the row corresponding to the PVI to be removed. Then, picking the Remove PVI button will delete the selected row/PVI from the Profile.

**Screen Pick PVI:** Picking this button allows the user to change the station of a PVI by screen picking a location in the drawing. Before picking the Screen Pick PVI button, the user must use the mouse to select/highlight a cell in the corresponding row of the PVI to be changed. Then, picking the Screen Pick PVI button changes the user to the active drawing screen, prompting the user to "Pick PVI Point:" in the drawing area.

**Show Sections:** This option is only available if the Template (.TPL) file for the Road has already been specified in the Edit Roads dialog box. When picked, the Show Sections button will open a "Road Design Section Data" viewer window while keeping the "Road Profile" window open as well. This provides the user a dynamic design environment in which the plan-, profile- and section-views are visible at one time. Additionally, when the "Section" viewer window is open, the notes at the top of the profile-grid-view include the "Cut" and "Fill" end-area at the current station along with the "Cut" and "Fill" volume for the entire Road. These calculations are dynamic and will update if changes are made to the design Profile. Use the Specific Station to check the section at a station. Or move the cursor in the profile preview graphic to change the section station.

![Road Profile View and Section Viewer with Station Indicator in Drawing](image)

**Translate:** Picking this button will display the Translate Profile dialog box and allows the user to change the elevation of the entire Profile or a range of stations along the Profile.
Translate Profile dialog box

Save: This button saves changes to the Profile (.PRO) file.
Exit: This button exits the Input-Edit Road Profile editor dialog box.
Undo: This button will undo the last change made to the Profile.
Setup: This button opens the Road Profile Settings dialog box. See below for more information.
Vertical Speed Tables: Use this button to specify the Vertical Curve Speed Table (.VST) files to use for the design of this Road.

Road Profile Settings Dialog Box

Reference CL File: In the Road Network feature, the "Reference CL File" is automatically set to the Centerline (.CL) file associated with the Road.
Hold Current Elevation: When enabled and the station and elevation of a PVI changes, the "Slope Out" of the adjusted PVI will change but the elevation of the next PVI will be left unchanged. Otherwise, if not enabled, the "Slope Out" of the adjusted PVI is held and the elevation of the next PVI is changed.
Grid Ticks Only: When enabled, only grid ticks will be shown in the profile-grid-view. Otherwise grid lines will be used.
Set Grid Interval: If enabled, this option allows the user to manually specify the grid- or grid-tick interval shown in the profile-grid-view.
Show Slope When Zoom In: When enabled, this option allows the user to display the slopes on those vertical tangents that are long enough to display a slope label when Zoom-ing in closer to the Profile.
Show Reference Surface: When enabled, this option displays the Profile of a "Reference Surface" in addition to the...
design Profile. The "Reference Surface" is typically the original or existing ground Profile.

**Show Reference Surface at Left Offset**: When enabled, this option allows the user to see an additional Profile that is offset horizontally from the "Reference Centerline". The offset distance can be specified after the option is enabled.

**Show Reference Surface at Right Offset**: When enabled, this option allows the user to see an additional Profile that is offset horizontally from the "Reference Centerline". The offset distance can be specified after the option is enabled.

**Show Centerline Special Stations**: When enabled, critical Centerline stations such as PC, PT, SC, ST, TS and SP are shown in the profile-grid-view.

**Show Vertical Lines for Intersections**: When enabled, this option will display a vertical line representing the Centerline and Edge of Pavement stations for other Roads in the Road Network.

**Show Sag-Crest Points**: When enabled, this option displays a marker at the sag and crest points of each vertical curve.

**Extend Reference Centerline**: When enabled, the user may provide an extended range of stations so as to show Profile data beyond that generated along the associated Centerline (.CL) file. For instance, for a new Road tying into an existing Road (proposed CL file starts at the Intersection of the Centerline of the existing Road) an extended range of stations may be desired in order to see the Profile of the cross-slope, curb, ditch and slope across both sides the existing Road.

**Output Reference Surface Profile** and **Suffix**: When enabled, this option will generate an existing ground Profile (.PRO) file and allows the user to specify a suffix for the filename. The defaults for this option are set using the **Output File Defaults** button in the **Output Options** tab of the **Road Network Settings** dialog box.

**Reference Surface**: The "Reference Surface" is an additional surface Profile shown in the profile-grid-view alongside the design Profile. For the **Road Network** feature, the "Reference Surface" is the surface specified as "Existing Ground" in **Road Network Settings** dialog box.

**Check Road Design Parameters**: When enabled, this option will compare the current Road design to an established set of design parameters set in a Road Design Parameters (.RDP) file. Please refer to the **Help** files for the **Road Design Parameters** command if additional assistance is needed.

**Display Sight Distance Options**: Use this radio button to display either a "Sight Distance" or "K-Value" column in the profile-table-view.

**Drag PVI Options**: Use this radio button to specify the design criteria to "hold" when using the **Edit/Drag PVI** command in the profile-grid-view. The options are to "Hold Vertical Curve Length", "Hold K-Value" or "Hold Sight Distance".

Intersections are created automatically in the **Road Network** feature without any input from the user. Once Intersections are identified, they are listed and managed in the **Intersection** area of the **Road Network: Task Pane**.
Intersection Area of the Road Network Task Pane

**Edit**: Use this button to display the *Edit Intersection* dialog box and make changes to the *Input Data* and *Output Files* for the selected Intersection. Other changes that can be made to the Intersection design are:

1) Changing the Primary/Secondary status of the Roads creating the Intersection,
2) Making design changes that apply to the entire Intersection,
3) Making design changes that apply to one or more Corners of the Intersection.

**Reset**: Use this button to overwrite all design changes made to the selected Intersection and reset to the original Intersection design.

As stated above, Intersections are created automatically in the Road Network feature without any input from the user. Road Network recognizes and calculates the Intersection using the Centerline (.CL) files associated with the Roads in the Network. If two Roads are added to the Network and they share one or more common point, an Intersection is created and displayed as an Intersection in the Road Network: Task Pane.

For all Intersections, one of the two Roads creating the Intersection will be the "Primary" Road and the other will be the "Secondary" Road. When setting grade through an Intersection, the Primary Road’s Template (.TPL) file takes priority and is used to define the cross-section. The grades of the Secondary Road will adjust to match the Primary Road. Additionally, changes to any of the Primary Road design files - such as the Profile (.PRO) file - will automatically update the affected file(s) of the Secondary Road.

Upon creation of an Intersection, the Road Network feature automatically designates one of the Roads as the Primary Road and the other as Secondary. For four-way Intersections, the first Road added to the Road Network will be deemed the Primary Road and the second Road will be Secondary. For T-Intersections, the Road going straight-through the Intersection will be deemed the Primary Road - even if it’s added to the Network after the Road that stops at the Intersection. The user can change the Primary Road designation in the *Edit Intersection* dialog box.

Picking the *Edit* button displays the *Edit Intersection* dialog box which has a *Settings* tab and, depending on the type of Intersection, 2 or 4 additional tabs - each representing one Corner of the Intersection. The Corner tabs are labeled *Front-Right, Back-Right, Front-Left* or *Back Left*. T-Intersections will have 2 tabs and 4-way Intersections will have 4 tabs.
Intersection Settings

At the top of the Settings tab, the station and elevation of the Intersection is shown for all Roads.

The Settings Tab of the Edit Intersection Dialog Box

**Primary Road**: Use the radio button to specify the Primary Road of the Intersection.

**Profile Transition PVI Distance**: This value represents the distance beyond the edge of pavement of the Primary Road (along the Secondary Road Centerline) that the cross-slope of the Primary Road will be extended.

**Profile Transition VC Length**: This setting allows the user to specify the length of vertical curve to be inserted at the PVI where the extension of the Primary Road's cross-slope and the Centerline of the Secondary Road meet.

"Profile Transition PVI Distance" and "Profile Transition VC Length"
**Template ID:** This is the point on the cross-section used to define the horizontal (Centerline) and vertical (Profile) alignments around the Corners of the Intersection. Also, the profile for the side road will tie into this Template ID on the main road. The Template ID may be specified as any point on the cross-section - such as edge of pavement (EP) or the back of curb (BC) - as long as it has been defined as a Template ID in all of the Template (.TPL) files used to calculate the Intersection. Type the Template ID in the text box or use the Select button to choose from a list.

**Additional Transition Distance:** This option adjusts the transition PVI station on the side profile. The transition station starts as the offset of the Template ID on the main road. The cross slope of the main road is used up to the transition station. For example, if the Template ID is for edge of pavement up to the gutter pan at 11.67 and the side profile needs to match the main crown up the the flow line at 13.00, then the Additional Transition Distance should be set to 1.33.

**Hinge Profile and 2nd ID:** For the side road profile, this is an optional second point to match from the main road template.
Cross-section of main road showing side (alley) profile tying into Template ID at flow line as well as 2nd Hinge at Right-of-way of main road

**Surface Method**: See the Transition Defaults section above for details on this setting.

**Transition Method**: See the Transition Defaults section above for details on this setting.

**Link Secondary Centerline for T-Intersection**: When this option is enabled, changes to the Centerline (.CL) file of the Primary Road will, if necessary, force the Centerline of the Secondary Road to be extended or trimmed in order to keep the Intersection intact.

Note: The default value for several design criteria such as Intersection radius and length of vertical curve can be set in the Transition Defaults tab of the Road Network: Settings dialog box.

**Corner tabs - Front-Right, Back-Right, Front-Left, Back-Left**

Depending on the type of Intersection ("T" or 4-way), there will be either 2 or 4 additional tabs available in this dialog box. Each of these tabs represent a Corner of the Intersection and allows the user to specify horizontal and vertical **Input Data** and **Output Files** specifically for that Corner.
Intersection Input Data

**Radius**: Use this value to specify the radius of the curve for this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab of this dialog box determines the point on the cross-section being affected by this setting.

**Tie to Existing**: Enable this option to keep cut and fill slopes from projecting to the existing ground through the Intersection. In areas of steep cut or fill, this setting helps avoid overlapping Road and Intersection tie slopes.

**Edit Profile**: Pick this button to open the **Input-Edit Road Profile** Editor and make changes to the Profile for this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab of this dialog box determines the point on the cross-section being represented in the Profile Editor. See **Road Network: Road Profile Editor** for more Help with this feature.

![Edit Profile for a Corner of an Intersection](image)

**Reset**: Use this button to overwrite all edits to the Profile of the Corner of the Intersection and reset to the original Profile.

**Edit Template Transition**: Pick this button to display the **Edit Intersection Transition** dialog box. This allows the user to control the stations for transitioning through the Intersection from a Template on one Road to a different Template on another Road. These Transition stations only apply when the Roads in an Intersection have been assigned different Template (.TPL) files.
In the Intersection Transition Dialog Box... The Starting and Ending Stations of the Intersection transition are displayed at the top of the dialog box.

**Transition Starting Station**: This is the station at which the Primary Road Template ends.

**Transition Ending Station**: This is the station at which the Secondary Road starts.

**Corner tabs (Continued)**

**Allow Single VC**: When the difference in grade at the Intersection between the Primary Road and the Secondary Road is too severe, two intermediate PVIs must be inserted into the Profile of the Corner of the Intersection in order to properly transition from one Road to another. In some cases, the transition is possible using only one intermediate PVI in the Corner Profile. If this option is enabled and if the intersecting grades allow it, only one intermediate PVI will be inserted. If this option is not enabled, two intermediate PVIs will be inserted regardless of the intersecting grades.

**Template Grade Table**: Pick this button to select an existing or create a new Template Grade Table (.TGT) file defining the grades for the Corner of the Intersection. This file allows the user to define specific slopes and distances for one or more Template IDs that have been assigned in the Template (.TPL) file. The **Edit** button opens the **Template Grade Table** Editor. This Editor is the same as the one used for the **Template Grade Table** command. Please refer to the **Help** files for that command if additional assistance is needed.

"L" Intersection with Knuckle: When two centerlines connect at a right angle for an "L" intersection, there is a **Use Knuckle** option for the outside corner that can be used to make a knuckle bulb.
Intersection Output Files

**Centerline:** Pick this button to output a Centerline (.CL) file representing the horizontal alignment around this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab determines the point on the cross-section exported to the Centerline (.CL) file.

**Profile:** Pick this button to output a Profile (.PRO) file representing the vertical alignment around this Corner of the Intersection. The **Intersection Template ID** specified in the **Intersection Settings** tab determines the point on the cross-section exported to the Profile (.PRO) file.

**Existing Section File:** Pick this button to output an Existing Section (.SCT) file for this Corner of the Intersection.

**Final Section File:** Pick this button to output a Final Section (.SCT) file for this Corner of the Intersection.

Cul-de-Sacs may be added to any Road in the Network and are managed in the **Cul-de-Sac** area of the **Road Network: Task Pane**.

Cul-de-Sac Area of the Road Network Task Pane

**Add:** Picking this button will display a list of Roads in the Network and prompt the user to "**Select Road for Cul-de-Sac**"... After selecting the Road, the **Edit Cul-de-Sac** dialog box is displayed allowing the user to specify the **Input Data** and **Output Files** for the Cul-de-Sac.

**Edit:** Use this button to display the **Edit Cul-de-Sac** dialog box and make changes to the **Input Data** and **Output Files** for the selected Cul-de-Sac.

**Remove:** Use this button to **Remove** the selected Cul-de-Sac from the Road.

**Add:** Picking this button displays a dialog box listing the Roads in the Network and prompting the user to **Select Road for Cul-de-Sac**.
Select Road for Cul-de-Sac

After choosing the Road and picking the OK button, the Edit Cul-de-Sac dialog box is displayed.

![Edit Cul-de-Sac Dialog Box](image)

**Edit Cul-de-Sac Dialog Box**

**Cul de Sac Input Data**

**Cul-de-Sac Centerline Position:** Use this radio button to specify whether the Cul-de-Sac is drawn at the starting or the ending station of the Centerline.

**Centerline Direction:** This setting applies only if the horizontal alignment of the Cul-de-Sac is to be saved externally as an **Output Centerline (.CL) file**. If so, this setting determines which end of the Cul-de-Sac is the starting and which is the ending station of the new Centerline (.CL) file.

**Center Station:** Use this setting to precisely locate the center of the Cul-de-Sac along the Road Centerline. By default, the **Center Station** is the starting or ending station of the Centerline depending on whether the user has chosen **Start** or **End** as the desired **Cul-de-Sac Centerline Position**. The station for the center of the Cul-de-Sac may also be entered in the text box or may be specified using a **Delta** value. When using the **Delta** option, the Cul-de-Sac will be shifted the specified distance along the Centerline.

**Cul-de-Sac Radius:** Use this value to specify the radius of the Cul-de-Sac bulb. The **Cul-de-Sac Template ID** determines the point on the cross-section being affected by this setting.

**Fillet Radius:** Use this value to specify the radius of the curve that transitions between the Road and the Cul-de-Sac.
The **Cul-de-Sac Template ID** determines the point on the cross-section being affected by this setting. **Offset**: When set to "0", this setting places the center of the Cul-de-Sac on the Centerline of the Road. Setting this value to a negative(-), greater than "0" value will shift the center of the Cul-de-Sac left of the Centerline by that distance. A positive, greater than "0" value will shift it to the right by that distance.

**Tear Drop Mode**: Enabling this option creates a longer transition between the Road and the Cul-de-Sac. When enabled, a value larger than the **Cul-de-Sac Radius** must be entered as the **Setback**. An example of a "Tear Drop" Cul-de-Sac having a 45' radius and 75' setback is shown below.

![Example of Tear Drop Cul-de-Sac](image_url)

**Template ID**: This is the point on the cross-section used to define the horizontal (Centerline) and vertical (Profile) alignments around the bulb of the Cul-de-Sac. The Template ID may be specified as any point on the cross-section - such as edge of pavement (EP) or the back of curb (BC) - as long as it has been defined as a **Template ID** in the Template (.TPL) file used for the Road. Type the **Template ID** in the text box or use the **Select** button to choose from a list.

**Profile Transition VC**: When adding a Cul-de-Sac to the Road Network, the Profile around the Cul-de-Sac is automatically generated having 3 PVIs - one on each end connecting to the Road and one at the mid-point of the alignment. The **Profile Transition VC** setting is the default length of vertical curve inserted at the middle PVI of the Profile. As shown below, adding a vertical curve at this PVI can have a significant, positive impact on the resulting surface model and contours of the Road Network.
Effect of Adding a Vertical Curve to Cul-de-Sac Profile

**Edit Profile**: Pick this button to open the **Input-Edit Road Profile** Editor and make changes to the Profile of the Cul-de-Sac. The **Cul-de-Sac Template ID** determines the point on the cross-section being represented in the Profile Editor. See **Road Network: Road Profile Editor** for more **Help** with this feature.

**Edit Profile for a Cul-de-Sac**

**Reset**: Use this button to overwrite all edits to the Profile of the Cul-de-Sac and reset to the original Profile. **Template**: Use this button to browse to and select an existing Cul-de-Sac Template (.TPL or .TSF) file. Specifying a different Template than the main Road allows the user to define different features for the Cul-de-Sac area such as sidewalk and curb.
Cul de Sac Output Files

**Centerline**: Pick this button to output a Centerline (.CL) file representing the horizontal alignment around the Cul-de-Sac. The **Cul-de-Sac Template ID** determines the point on the cross-section exported to the Centerline (.CL) file.

**Profile**: Pick this button to output a Profile (.PRO) file representing the vertical alignment around the Cul-de-Sac. The **Cul-de-Sac Template ID** determines the point on the cross-section exported to the Profile (.PRO) file.

**Existing Section File**: Pick this button to output an Existing Section (.SCT) file for the Cul-de-Sac.

**Final Section File**: Pick this button to output a Final Section (.SCT) file for the Cul-de-Sac.

Note: Driveways around a cul-de-sac can be easily added simply by drawing polylines for their centerlines and snapping them to the EOP of the cul-de-sac.

**Step 1: Start Road Network and Configure Settings**

Open a Drawing (.DWG) file containing the 2D zero-elevation polylines representing Road Centerlines for the project. Start the **Road Network** command and create a **New** Road Network (.RDN) file. After creating the Road Network file, the **Road Network Task Pane** loads as a docked dialog-box on the left side of the drawing screen.

Configure the Road Network by **picking the Settings button** and displaying the **Road Network Settings** dialog box. In the **Process Options** tab, **pick the Existing Surface button** and browse to and select the Existing Ground Surface (.TIN or .FLT) file to be used for the project.

![Road Network Settings](image)

**Process Options Tab**

Next, **switch to the Output Options tab** and **pick the Setup button** next to **Triangulate and Contour**. **Select the Write Triangulation File option** and then **pick the Browse button** to set the path and filename for the design Surface (.TIN) file for the Roads.

Chapter 6. Civil Module
Output Options Tab

Also in the Output Options tab, pick the Output File Defaults button to display the Output File Defaults dialog box. Pick the Output File Defaults button to specify additional Centerline (.CL), Profile (.PRO) and Section (.SCT) files to be saved when Processing the Road Network.

Output File Defaults Dialog Box

Next, review the Report Options, Display Options and Transition Defaults tabs of the Road Network Settings dialog box and make any necessary changes.
Pick the OK button to close the Road Network Settings dialog box and then pick the Save button on the Task Pane to save the settings to the Road Network (.RDN) file.

**Step 2: Add Roads to the Network**
In the Road Name area of the Road Network Task Pane, pick the Add button.

Road Name Area of the Road Network Task Pane

After picking the Add button, the Add Road dialog box provides two methods for adding a Road to the Network. Pick the Screen Pick Polyline button.
Specify Method to Use to Add Road

The prompts then switch to the Command: line where you are prompted to Select Centerline Polyline in the drawing. At the next prompt, pick the Assign Centerline File to Polyline button and set the path and filename for the new Centerline (.CL) file.

Set Centerline Dialog Box

Immediately after creating the new Centerline file, the Profile to Use file dialog box is displayed. In this box, you must set the path and filename for the proposed Profile (.PRO) file for the Road. By default, the new Profile (.PRO) file is named the same as the Centerline (.CL) file.

Profile to Use File Dialog Box

After specifying the Centerline (.CL) and Profile (.PRO) files for the Road, the Edit Road dialog box is displayed. The only other Required Input File is a Template (.TPL) file. Pick the Template button to browse to and select the desired Template file.
Select Template (.TPL) file Dialog Box

The Edit Road dialog box serves as the "manager" for all files relating to the specific Road. The Edit button in the Road Name area of the Road Network: Task Pane also displays the Edit Road dialog box.

Edit Road Dialog Box

Pick the Edit button to the right of the Profile button to open the Road Profile Editor.
In Carlson’s Road Network feature, the initial design Profile is automatically generated and has only a starting and ending PVI - with the elevation at both ends tying into existing ground. The movement of the crosshairs is locked to the design Profile. The initial PVIs can be seen in the profile-grid-view where the existing ground Profile is shown in red and the design Profile in white. The initial PVIs are shown in the table-view with the “PVI Description” indicating the PVI elevation is tied to the “TARGET-SURFACE” (existing ground).

Pick the **Add PVI** button to create a new PVI by screen-picking a point in the profile-grid-view at the top. After picking the Add PVI button, the New PVI dialog box is displayed.
Enter a length for a vertical curve or change other settings as desired and then pick the **OK** button. Repeat as needed for additional PVIs and vertical curves.

**Input-Edit Road Profile Editor**

Pick the **Show Sections** button at the bottom of the *Road Profile Editor* to display a **Section View** of the Road. Moving your crosshairs along the design Profile dynamically updates the **Section View**.

**Section Viewer**

When the **Section View** window is open and active, the *Road Profile Editor* also remains open and active. If you position the *Road Profile Editor* and the **Section View** window so that the drawing view of the Road is unobscured, you can move your crosshairs along the design Profile and have a dynamic design environment allowing you to see the plan-, profile- and section-views at one time. Additionally, when the **Section View** window is open, the notes at
the top of the profile-grid-view include the "Cut" and "Fill" end-area at the current station along with the "Cut" and "Fill" volume for the entire Road. These calculations are dynamic and will update if changes are made to the design Profile.

### Road Profile View and Section Viewer with Station Indicator in Drawing

Pick the **Exit** button to close the **Section Viewer** and then pick the **Save** button in the **Road Profile Editor** to save changes to the Profile (.PRO) file. Pick the **Exit** button to close the **Road Profile Editor**.

Repeat the steps above to define additional Roads in the Network.

See **Road Network: Adding and Editing Roads** if you need additional assistance.

### Step 3: Adding and Editing Intersections

After Adding the next Road, the **Road Network** command recognizes the creation of an Intersection and the Primary and Secondary Roads are displayed in the **Intersection** area of the **Road Network Task Pane**.
Intersection Area of the Road Network Task Pane

Select the Intersection and pick the Edit button to display the Settings tab of the Edit Intersection dialog box. Make changes as needed.

Note: Changes made here apply to all Corners of the Intersection.

The Settings Tab of the Edit Intersection Dialog Box

Or, you can switch to one of the Corner tabs - Front-Right, Back-Right, Front-Left, Back-Left to make changes to only one Corner of the Intersection.
One of the "Corner" Tabs of the Edit Intersection Dialog Box

Pick the OK button to close the Edit Intersection box and save changes.

See Road Network: Adding and Editing Intersections if you need additional assistance.

**Step 4: Adding and Editing Cul-de-Sacs**

Pick the Add button in the Cul-de-Sac area of the Road Network Task Pane to display a dialog box listing the Roads in the Network and prompting you to Select Road for Cul-de-Sac.

Select Road for Cul-de-Sac

After choosing the Road and picking the OK button, the Edit Cul-de-Sac dialog box is displayed. At a minimum, you must enter a Cul-de-Sac Radius and Fillet Radius to define the Cul-de-Sac.
Edit Cul-de-Sac Dialog Box

*Pick the OK button* to close the Edit Cul-de-Sac box and save changes.

See Road Network: Adding and Editing Cul-de-Sacs if you need additional assistance.

**Step 5: Save, Process and View the Road Network**

*Pick the Save button* on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, *pick the Process button* on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The resulting contours and breaklines are shown below.
Contours and Breaklines After Processing Road Network

The elevated breaklines and contours can now be viewed using the **3D Viewer Window** command as shown below.

Breaklines and Contours as Seen in the 3D Viewer Window

Or, use the **Surface 3D Viewer** command to view the Surface (.TIN) file as shown below.
Surface (.TIN) File as Seen in the Surface 3D Viewer

Or, use the **Surface 3D Flyover** command to drive the Surface (.TIN) file as shown below.

---

Step 6: Reports

*Pick the *Report* button* on the **Road Network Task Pane**. Then, *pick the *Output Processing* button* to display the report. This report displays the cut/fill and material quantities for each Road, Intersection and Cul-de-Sac of the Road Network.*
Road Network Output Processing Report

Repeat this step but, this time, pick the Input Data Files button to display the report. This report displays all of the user-specified design files associated with the Road Network. For this report, you are given the option of reporting only the filename or both the path and filename.

Road Network Input Data Files Report

Step 7: Additional Settings and Tools in the Road Network

Draw Triangulation Faces with Color and View in 3D Viewer Window

Pick the Settings button on the Road Network Task Pane and then pick the Output Options tab. Now, pick the Setup button next to Triangulate and Contour to open the Triangulate and Contour from Road Network dialog box.

Select the Draw Triangulation Faces option and then pick the Set Colors/Layers buttons to display the
Road Color Settings dialog box (shown below). The color of the faces can be set either by using the Template IDs defined in the Template (.TPL) file or using a color range based on the "Cut & Fill Depths".

Set Road Colors In the "Triangulate and Contour From Road Network" Dialog Box

Pick the Exit button to close the Road Color Settings box and then pick the OK button twice to exit both the Triangulate and Contour and Road Network Settings dialog boxes.

Pick the Save button on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, pick the Process button on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The image below shows only the Triangulation Faces after Processing.
Triangulation Faces with Color After Processing Road Network

The elevated Triangulated Faces can now be viewed using the 3D Viewer Window command as shown below.

Contours and Triangulation Faces with Color in the 3D Viewer Window

Merge Road with Existing
Pick the **Settings** button on the **Road Network Task Pane** and then **pick the Output Options** tab. **Select the Merge Road with Existing option** and then **pick the Set button** to set the path and filename of a 3rd Surface (.TIN) file to be created by combining the design Surface file and the Existing Ground Surface file.

*Pick the OK button* to close **Road Network Settings**.

*Pick the Save button* on the **Road Network Task Pane** to **Save** the Road Network (.RDN) file.

Then, **pick the Process button** on the **Road Network Task Pane** to calculate the road design and perform the functions specified in **Road Network Output Options**

The combined Surface (.TIN) file can now be viewed using the **Surface 3D Viewer** command as shown below.

![Merged Existing Ground and Road Surfaces in 3D Surface Viewer Window](image)

**Add Knuckle Intersection**

Using the steps outlined in **2 Add Roads to the Network** above, Add two more Roads to the Network.
RD_03 and RD_04

Upon adding the Roads, the new Intersections are automatically added to the Intersection area of the Road Network Task Pane.

**Intersection Area of the Road Network Task Pane**

To create a "Knuckle" style Intersection between RD_03 and RD_04, select the RD_03 (Primary)/ End:RD_04
(Secondary) Intersection in the Task Pane and then pick the Edit button to display the Settings tab of the Edit Intersection dialog box. Pick one of the "Corner" tabs of the Edit Intersection dialog box. Select the Use Knuckle option and enter a Main Radius and Fillet Radius value for the Knuckle Intersection.

![Edit Intersection dialog box](attachment:image)

A "Corner" Tab of the Edit Intersection Dialog Box

Pick the OK button to close Edit Intersection.

Pick the Save button on the Road Network Task Pane to Save the Road Network (.RDN) file.

Then, pick the Process button on the Road Network Task Pane to calculate the road design and perform the functions specified in Road Network Output Options. The resulting contours and breaklines are shown below.
Step 1: Start New Road Network

Start the Road network command. If you have previously run Road Network with the current drawing, the Road Network docked dialog will open with the last Road Network (.RDN) file you worked with. If this happens, but you prefer to create a new Road Network (.RDN) file, click the Load/New button at the bottom of the Road Network docked dialog.

Step 2: Add Roads

Back in the main dialog, click "Add" in the upper left "Road Name" portion, and identify all of the main road and secondary (intersecting) road centerlines. For this example, we will start by identifying North Road and East Road as the main roads and Paris Boulevard as the first secondary road. Note that centerlines may be picked as polylines or loaded as centerline files. All centerlines (horizontal alignments) must have, at minimum, an associated profile (vertical alignment) and an associated template. In the Road name dialog portion, select a road and click Edit to review the files. Note that by selecting Paris Boulevard and East Road, the program automatically detects the first intersect. As you follow the design below, you will see that we follow the hierarchy of the road precedence as outlined in the graphics. At every intersection, there needs to be a primary controlling road (template cross slopes are held) and secondary adjusting road (centerline profile adjusts to template of primary road at some transition distance).
Step 3: Process, Review and Add more

Click Process to compute the design. With the Triangulation option enabled under the "Settings" dialog, the program will Triangulate and Contour and create the drawing shown below. If you edit any road feature or dialog entry and click Process again, the program automatically clears the last Triangulate and Contour drawing and creates a new final design drawing. In this way, you can trial-and-error your design for all roads, or build the design in stages.

Viewing the file in the 3D Viewer Window command with a 4.0 vertical exaggeration, you can even see how the curb-and-gutter Paris Boulevard ends abruptly as it transitions to the roadside ditch template of East Road.
Next we can review the effect of adding Front Drive, Loop Road and West Drive into the equation. If you click Edit after adding Loop Road as above, you have the option to change any aspect of the centerline, profile or template file, and you can add optional files such as road width change files and superelevation files. For example, if you choose to edit the profile, the program derives the existing grade from the existing surface triangulation file specified in Settings, and you are able to design graphically and interactively as shown:

You can also more closely analyze the intersections of any road. If you select the intersection at ParisBlvd and Start:LoopRd, you obtain the multi-tab dialog:
Since we do not have a crossing intersection, we only obtain a "Front-Left" tab and a "Back-Left" tab, left being the left side of the primary road (Paris) and front being the first "curve return" treatment on the outside of the loop and back being the second "curve return" treatment on the inside of the loop. If this was a crossing intersection, you would have 2 more tabs in the dialog: "Front-Right" and "Back-Right".

Completing West Drive, Front Drive and South Drive leads to the following plan view and 3D view. Clicking Add within the Cul-de-Sac portion of the docked dialog enables you to specify at cul-de-sac at the end of South Drive.

Clicking Process now produces the following:

A close-up view of the cul-de-sac, in 3D, reveals the detail of the design, showing a raised "fold" due to no vertical curve transition at the projected high point at the back of the cul-de-sac:
This dimple effect can easily be eliminated by lowering the elevation of the "PVI" at the projected intersect point in the back of the cul-de-sac, and by adding a vertical curve transition of, say 50'. This is done by highlighting the South Drive Cul-de-Sac and clicking Edit.

Clicking Edit on the selected SouthDr at End cul-de-sac leads to this dialog:

The first thing we do is change the Profile Transition VC from 0.0 to 50.0, as shown. Then we need to click Edit Profile to lower the profile at the back of the cul-de-sac. This profile refers to the edge-of-pavement grade.
Now, after clicking Process, the cul-de-sac has a better design:

**Pulldown Menu Location:** Roads → Road Network  
**Keyboard Command:** roadnet  
**Prerequisite:** Existing Ground Surface (.TIN) file, Template (.TPL) file and 2D Centerline Polylines
Process Design Sections

This command will process design sections to calculate volumes and output surfaces. The main purpose is to process design sections that have been manually adjusted. One workflow is to use Process Road Design to generate design sections from a centerline, profile and template design. Next these design sections can be adjusted with Input-Edit Section File for special stations as needed. Then use Process Design Sections to run these modified sections.

The first dialog specifies the required input files of the centerline, existing surface and design sections. The optional output files for coordinates, mass diagram and superelevation diagram are set here.

The second dialog has the processing and output settings which are a subset of the settings from Process Road Design. Please see the Process Road Design section of this manual for a description of these settings.

Pulldown Menu Location: Roads
Keyboard Command: reworks
Prerequisite: Centerline (horizontal alignment), Existing and Final Cross Sections
Road Design Inspector

This routine takes a full suite of road files (existing and final profiles, existing and final cross sections and the centerline) and presents three graphical windows showing the road in plan view, profile view and section view, with a slide bar that let's you "drive" the road or project from start to end. In addition to applying to roads, the command applies to any set of existing and final sections that follow a horizontal alignment (centerline), such as for channels and embankments. As you move the slide bar left and right, your position is shown in profile view, in plan view and in cross section view. The cross section graphics can be scaled to fit the allotted screen space, or can be set to a scale such as 1H:1V or set to exaggerated scales (2H:1V up to 10H:1V).

The current station is displayed as you move the slide bar. You can zoom and pan the cross section view, and you can also enter a specific station to study. Stations that do not exist in the cross section files will be interpolated.
Pulldown Menu Location: Roads
Keyboard Command: rdcheck
Prerequisite: Existing and final Profiles (vertical alignment), Centerline (horizontal alignment), Existing and Final Cross Sections

**Locate Template Points**

This command creates Carlson points along a centerline either at picked points, point numbers, entered individual station and offset or at station interval with offset, in all cases using the elevations calculated from the template design files. The first offset prompt is for the location of the point. The second offset prompt is for what elevation to use. For staking template points (e.g. edge of pavement) you usually enter the same offset for the position and for the elevation. But if you are staking back of curb, which might be at offset 14.5, you might enter 16.5 for the position (to stake 2' back of curb) and 14.5 for the vertical elevation (to use the elevation of back of curb itself). The points are stored in a coordinate (.CRD) file. The station and offset of the point is stored in the point descriptions. If the points method is used and existing Carlson points are selected by number, range or "point group", then new points at the same position are created with interpolated elevations and new descriptions. The command starts with the dialog shown below. The required design files include the template file, the profile which defines the vertical alignment, the centerline file which contains the horizontal alignment and the coordinate file for storing the resulting points. All these design files must be created before running this command. To specify a design file, pick on the type of file button. The optional files include an existing section file for calculating the cut and fill slopes, a rock section file for special cut slopes in rock, a template transition file and a super elevation file. For example, if an existing section is specified, template points can be calculated further from the centerline, all the way from the shoulder out to the "catch" or tie point in cut and fill.

![Template Points Dialog](image)

If you choose the Station/Offset method, you can specify whether to create points at a station interval. Otherwise the program prompts for each station at which to create points. If the Station/Offset method is used, you will be prompted whether to calculate points on the left, right or both sides of the centerline and whether to offset the calculated elevation by a delta Z amount. If you choose the Points method, you can pick points on the screen (using snaps on entities if desired) or you can specify point numbers individually, by selection set, by range or by point group. You can also select whether to calculate elevations from the template surface or from a subgrade and you can add a description prefix to all descriptions.
A classic application of this routine would be for road staking such as setting back of curb points. Many survey companies prefer to stakeout roads by pre-calculated point numbers rather than calculating from road design files in the field to stakeout road offsets. So if the goal was, for example, to stake 2 feet behind the back of curb, but use the elevation of the top of curb, and the shoulder rose at 4% behind the curb, then the vertical difference to the top of curb would be \(-2\times0.04=-0.08\). The program will calculate this automatically by the method of asking for the distinct offset to use for the elevation. Obviously, if you want to stake to the exact surface elevation at the offset specified, then enter the same offset for both position and elevation. The prompting for this back of curb example is shown below.

![Diagram of back of curb stakeout](image)

**Prompts**

**Template Points dialog:** Specify the required files and optional files.

**Additional Options dialog:** Choose Station/Offset or Points method, as shown below:

Chapter 6. Civil Module
Offset for X,Y position: 16.5 In this case, this is the pavement width (12.5) plus curb width (2) plus back-of-curb offset (2). The northing and easting for the points will be calculated with this offset.

Offset for elevation <16.5>: 14.5 The elevations for the points will be calculated at this offset (back of curb in this example).

Apply offset to left, right or both sides (Left/Right/<Both>)? press Enter Note that if you want to have the points number sequentially on the left side and sequentially on the right, then do L for left first and R for right second. If you answer “Both” then the numbering will go sequentially left to right on each station (see below).

Offset to process (Enter to End): press Enter Or, enter an offset to calculate another X,Y position, or the same X,Y position but on a different side of the road if doing L and R distinctly.

Pulldown Menu Location: Roads
Keyboard Command: tplpts
Prerequisite: A template file, profile file and centerline file
Surface Menu

Overview

The Hydrology Module consists of several routines that work together in sequence. This manual only explains the operation of the commands and not hydrology concepts. For example, you will need to know the storm type and soil type for your area. Some routines are based on the TR-55 programs and the TR-55 manual, Urban Hydrology for Small Watersheds, may be useful. The Hydrology Module also links to other hydrology programs including HydroCAD, TR-20, SEDCAD, HEC-RAS and HEC-2. HydroCAD does stormwater modeling. TR-20 is used for hydrograph routing. The SEDCAD links are with capacity files for pond design and by drawing SEDCAD hydrographs. SEDCAD, by Civil Software Design, is used for the computation of flows and sedimentation. The HEC-RAS and HEC-2 programs are prepared by the Corps of Engineers to compute water surface profiles in stream and river channels.

Surface Commands

The pull-down menu for the Surface commands of the Hydrology module is shown here. Most of these commands are also in the Civil Design module and are described in that manual. These Surface commands are included in Hydrology for preparing the surface models to be used in commands such as watershed modeling.

<table>
<thead>
<tr>
<th>Surface</th>
<th>Watershed</th>
<th>Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make 3D Grid File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw 3D Grid File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid File Utilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triangulate &amp; Contour</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Triangular Mesh</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triangulation File Utilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elevation Zone Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slope Zone Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slope Report</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slope At Points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Soil Loss</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Universal Soil Loss

This command calculates the volume of sediment that can be expected from a watershed by soil erosion due to precipitation. It allows the user to specify multiple watershed areas, each with its own set of geometric and hydrological parameters. The Universal Soil Loss Equation (USLE) is used in calculating the soil loss. For each area, the area, slope and length can be manually entered by the user or it can be calculated by the program directly. For direct calculation of the geometric properties of the area, the user must have a grid file that models the surface. This can be created using the Make 3D Grid File command. In addition, the area must be defined by closed polylines for inclusion perimeter. Exclusion perimeters are optional for excluding areas from calculations.

The program starts with the dialog below, where the user can add as many areas as needed to include in the USL calculation. Each area added is shown in the list box with all its parameters listed. To add a new area, click the "Add" button. To edit the parameters of an existing area, highlight that item and click the "Edit" button. To remove an existing area, highlight it and click "Remove".
The "Edit" or "Add" button brings up the dialog box shown here, where the various parameters of the area can be specified or edited. The "Landuse" is just an identifier for the area and has no further significance. Soil Erodibility, $K$ (tons/acre) is a property of the soil, which determines the amount of sediment resulting from a precipitation event in an area. The rainfall factor, $R$, is a dimensionless factor that accounts for the relationship between erosive forces of falling rain and runoff. The Cover factor, $C$, is a dimensionless factor that relates the effectiveness of vegetal cover in reducing erosion. The Topographical factor, $L_s$, is a dimensionless length slope factor that accounts for variations in length and slope in the area. The (Conservation) Practice factor, $P$, is a dimensionless factor to determine how landuse affects its erodibility.

If the area of the watershed is known and is entered manually, then the length and slope of the area have to be entered manually as well and the $L_s$ factor will be calculated from these geometric properties. The area can also be calculated directly if the boundary is defined as a closed polyline and the grid file that models the surface is also made. The user clicks the button "Select area" and the program asks the user to select the grid file as well as the closed polyline representing the area. Then, the $L_s$ factor and the slope are calculated by the program and displayed (the "length" is not needed in this case). After filling in all values, click on "Calculate USL" to calculate the soil loss rate per unit area for the area selected. The user can change the parameters corresponding to this area and recalculate, if needed. Click "OK" to return to the main dialog box. The area should now appear in this dialog box if the parameters as specified.

After all required areas are input, the sediment volume can be calculated by clicking the "Calculate" button on the main dialog. This brings up the USLE Calculation dialog box as shown here. Specify the Delivery ratio, which determines what portion of the gross erosion is actually left for deposition at the final destination, accounting for losses during sediment transport. Also, specify the Time period for which deposition has occurred. Specify the Density of the sediment, so as to be able to determine the volume of the deposit from its mass in tons. Also, specify the amount of Rainfall (inches or cm) for which runoff volume has to be calculated. The program then calculates the Runoff volume based on the total area and the amount of rainfall. It also calculates the sediment volume, using the Universal Soil Loss Equation (USLE) and adds it to the sediment volume and reports it as the total pond volume. A report of the form shown below is generated. This report also gives a detailed account of the calculations performed. For further information about the estimation of the various parameters used in this program or about the USLE, please refer to "Applied Hydrology and Sedimentology for Disturbed Areas" (1981), Barfield, B.J., Warner, R.C. and Haan, C.T., Oklahoma Technical Press.
Pulldown Menu Location: DTM in Hydrology
Watershed Menu

The Watershed menu is shown below. The first section of commands are for watershed analysis and are primarily based on TR-55. These commands are arranged in the order that they would be applied. The first commands calculate the watershed boundary. Using the watershed area and land use types, the curve number can be calculated, which leads to time of concentration and hydrographs. Then the peak flow can be calculated. The second section of commands are for hydrograph routing using TR-20. The bottom section has commands for linking to SEDCAD, HEC-RAS and HEC-2.

<table>
<thead>
<tr>
<th>Watershed</th>
<th>Structure</th>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define Runoff Layers</td>
<td>Watershed Analysis</td>
<td>Runoff Tracking</td>
</tr>
<tr>
<td>3D Polyline Flow Values</td>
<td>Rainfall Frequency &amp; Amount</td>
<td>Sub-Watersheds by Land Use</td>
</tr>
<tr>
<td>Curve Numbers (CN) &amp; Runoff</td>
<td>Calculate C-Factor</td>
<td>Time of Concentration (Tc)</td>
</tr>
<tr>
<td>Peak Flow</td>
<td>Watershed Settings</td>
<td></td>
</tr>
</tbody>
</table>

Define Watershed Layers

This dialog box is the interface to assign specific Ground Covers to closed polylines in a drawing, based on their drawing layers. There are 3 modes of operation; Rational Method, SCS Method, and HydroCAD.

With the dialog set to Rational Method, the runoff coefficients are the C-Factors in the Rational Equation \( Q = C \times I \times A \). \( Q \) is flow, \( I \) is rainfall intensity and \( A \) is area. The Rational Method is often used for urban and residential flow analysis. For example, building layers can be assigned a high runoff coefficient (C factor) such as 0.85 and wooded areas would be assigned a low runoff coefficient such as 0.20.

With the dialog set to SCS Method, the coefficients are set to values from 0-100, so Roofs might be 85 and Woods 20. A Soil Type must also be specified for each Ground Cover.

With the dialog set to HydroCAD, the runoff coefficients are not set at all, but are added when the data is exported to HydroCAD.
With the Rational or SCS Methods, the runoff coefficient area polylines are used to determine the weighted runoff coefficients for drainage areas in conjunction with other Carlson Hydrology commands such as Watershed Analysis and Edit Sewer Structure. The runoff coefficient polylines are automatically clipped by the drainage perimeter polyline to find the coefficient sub-areas within the drainage perimeter. Therefore, it is important to close all polylines, use distinct layers for features that have distinct runoff values, and to assign a runoff coefficient to the unassigned, “remainder” areas. It is also important to enclose areas beyond the site with closed polylines and assign runoff coefficients to those layers to account for the off-site water entering the site.

Looking at Rational Method first, the initial dialog box would look something like this:

![Dialog box for defining watershed layers]

Adding or editing a layer brings up the next dialog:
The Library button brings up the next dialog, where new Ground Covers can be added from the Rational Method library.

For each layer, an area name and runoff coefficient are assigned and can be selected from the library. This library itself is defined under the Network pulldown menu, option Drainage Runoff Library within the Sewer Network Libraries "flyout". Each layer also has hatch settings for drawing the runoff areas. The hatch settings include the layer, color, pattern and scale. The Auto Hatch Scale option will size the hatch scale to fit the runoff area. The Hatch All button will hatch all the runoff areas in the drawing as closed polylines and defined in the list. The Hatch Selected will hatch the area of the currently selected layer from the list. The purpose of the hatch functions are for visual checks that the layers and closed polylines are set right.

With the SCS Method in use, the primary dialog would look something like this:
Adding or editing a layer brings up the next dialog:

The Library button brings up the next dialog, where new Ground Covers can be added from the SCS Method library. Select a Cover Description line, and then pick a Soil Group button, A, B, C or D.
Using the HydroCAD method, the initial dialog might look something like this:

Note there are no Curve Numbers listed, and the Default Runoff Curve Number field is grayed out.

Editing a layer brings a dialog like this:
Note that you can change the Layer name, but not the description of the Ground Cover. This is because the specific descriptions provided for HydroCAD Ground Covers must exactly match the description specified within HydroCAD itself.

Picking the Library button accesses the HydroCAD Ground Cover library.

Back in the primary Define Watershed Layers dialog box, the list of layers and other settings can be saved as .RCL files. It is useful to save and recall the configurations in .RCL files using the SaveAs and Load options. The currently loaded assignment is applied within the command Watershed Analysis.

There is also a Create Layers button, which creates the layers from the list in the current drawing. All layers can be created, or certain layers can be selected before picking the Create Layers button and you can specify to create only the selected layers.

There are settings for the default area name and default coefficient that are used for any part of the drainage area that is not covered by one of the runoff layer polylines.
The Soil layers are optional for finding the soil sub-areas within each runoff sub-area. These Soil layers are used in commands that calculate the runoff sub-areas within a watershed boundary such as the Select Watershed function within the Curve Numbers & Runoff command. When the Soil layers are assigned, the program will get all the linework on the Soil Linework layer to build a topology of the soil areas. The linework does not need to be made of closed polylines but the linework collected together should enclose the soil areas. Then the program takes the text entities in the drawing that are on the Soil Label layer. The text is used to identify the soil group. The first character in the text should be A, B, C or D for the four soil groups. The program looks for the text to be within the soil area to assign the soil group to that area.

The Watershed Linework layer is used in commands for selecting the watershed area by picking a point within the area. For instance, the Select Watershed routine in Curve Numbers & Runoff will prompt whether to select by perimeter (closed polyline) or interior point (watershed layer method), when the Watershed layer is defined. Similar to the Soil Linework layer, the program will get all the linework in the drawing that is on the Watershed layer and build a topology of the watershed areas. The linework does not need to be made of closed polylines but should make closed watershed areas when taken together. When you pick the interior point, the program finds the watershed linework that encloses the point to get the watershed perimeter.

The Watershed Label layer is used by the Hydro Network commands to match the drawing watershed area with the subcatchment node in the network. The match is between the value of a text entity on the watershed layer with the name of the subcatchment node.

The runoff polyline areas use region logic where a polyline inside another on the same layer is used as an exclusion. A limitation is that polylines on the same layer must not intersection each other. For polylines on different layers, there can be polylines within other polylines and for any given point, the smallest enclosing polyline is used to determine the runoff coefficient.

Example 1: In the example below, the site perimeter polyline is on the Regions layer, the building pads are on the Pads layer and the edge of pavement polylines are on the Roads layer. All these polylines are closed polylines. The areas within the buildings are inside both the Region and Pads polylines and the Pads govern because they are the smaller area. Likewise the road areas are governed by the Roads layer and road interior islands are not counted for Roads because the interior Roads polyline acts as an exclusion perimeter. The rest of the area is set to the Regions layer.
Example 2: Consider the subdivision shown below.

Buildings, roads, driveways, lot lines and wooded areas are in distinct layers. As soon as the command is selected the dialog below appears. The applicable layers can then be organized as follows within the command. Note that the lot lines do not have any hydrology impact and are not included in the layer-runoff coefficient assignment.
Example 1 used the built-in logic to remove closed polylines from outer enclosing closed polylines. So in the example 2 case, the overall property boundary had a runoff coefficient of 0.2 that was assigned its runoff coefficient by layer, and all other assigned closed polylines found within it (roads, buildings, driveways) will be calculated distinctly. For example 2, the entire "remainder" area that is not assigned and is given a default runoff coefficient, such as 0.5 shown above. Therefore, within any site perimeter, both the "unassigned" method for remainder areas or the assigned, outer boundary layer method for the remainder areas can by used. When the "Hatch All" button is clicked, the drawing will hatch in the defined colors and layers, as shown below:

**Pulldown Menu Location:** Watershed

**Keyboard Command:** define_runoff_layers

**Prerequisite:** Closed polylines on different layers for the different areas
Watershed Analysis

This command has a collection of tools to analyze the runoff of a surface defined by a triangulation or grid surface file. After selecting the surface file of the surface, the program docks a dialog on the left side of the drawing window. While the Watershed Analysis dialog is running, other AutoCAD and Carlson commands are not available. To zoom or pan the drawing view, use the buttons at the top of the dialog, or use the middle button of a wheel-mouse.

Watershed Analysis calculates the flow connections between the triangles and along the edges of the triangulation. The **Rainfall** amount is used in the processing for figuring the runoff volume to determine when the volume is enough to spillover a local depression in the surface. Besides the Rainfall amount, the runoff coefficients as defined in Define Runoff Layers are also used to calculate the runoff volumes. When the local depression is small enough the runoff will continue through. Otherwise this spot is called a sink for where the runoff stops. The **Round to dZ** is a process option that rounds the elevations of the surface model to simplify the processing. Set this value to zero for no rounding. The **Allow Overflow Along Boundary** option applies to watersheds that have runoff that hits the surface border. This option will check whether this border runoff can spillover and merge with the neighboring watersheds along the border.
The Draw Watersheds function draws the watershed areas using the settings under the Draw tab. The back arrow next to the Draw Watersheds button will erase any previous Draw Watershed entities. The Watershed Perimeters option will draw closed polyline perimeters for each watershed area. The Fill Watershed Areas option will solid fill hatch each area using different colors. The Buffer Hatch option will hatch the perimeters of the watershed areas with the specified width instead of hatching in the entire watershed area. The Hatch Structure Areas option will hatch the drainage areas covered by structure inlets defined in the Structures tab. The Sink Locations setting draws a symbol at the low point for each drainage area. The High Point Locations option draws a triangle symbol at the highest point within each watershed. Typically, this high point will be along the watershed boundary polylines that follow the high points along the ridges between the watersheds. The Pond Areas option draws a solid fill hatch in blue for the area covered by the runoff volume of low points. In the example shown, the Fill Watershed Areas and Sink Locations options are active. The Max Flow Lines option draws polylines for the longest flow line within each watershed. These longest flow polylines can be used to calculate the time of concentration. The Spillover Location option draws symbols at low points within the watershed area that fill up with runoff and spillover on the way to the lowest (sink) location of the watershed. The Setup button allows you to specify criteria for identifying spillover points. These settings include the minimum drainage area, storage volume, drainage volume and ponding depth. These settings allow you to filter out small spillover points (ie a pothole) and only draw the significant ones. The Group Watershed Entities option will make AutoCAD groups for the set of entities drawn for each watershed. The Symbol Options and Layer Options buttons allow you to set the symbols and layers to use for the entities created by Watershed Analysis.

The Above Point function reports the watershed data of the current pointer position in real-time as the pointer is moved around. The watershed data is shown in a tooltip next to the pointer position. This data has values for the overall watershed that the position is in including the sink elevation, sink name, drainage area and average slope percent. This data also has values for the watershed above the current point including the drainage area and runoff volume. Plus this data shows the elevation and runoff coefficient at the current point. If the position is picked with the mouse, then the program draws a polyline perimeter for the drainage area above the current point.

The Above Line function is similar to Above Point except that you pick two points and the program draws the watershed for all flow that crosses the line between these two points. For example, you can pick points at the left and right banks of a stream to get the drainage area for that stream above these points.
Under the Tools tab there are several analysis routines. The **Runoff Tracking** function draws flow lines that follow the surface. The **Single Point Tracking** method draws the flow lines starting from the picked high points. The **Whole Surface Tracking** method draws a flow line starting from the middle of each triangle in the triangulation. The **Major Flow Tracking** method draws starting in triangles where the drainage area coming into triangle exceeds the specified **Cutoff Area Above** value. The flow lines can be drawn as either 2D or 3D polylines. For 2D polylines, the linetype can be specified or the special linetype with flow direction arrows can be used. This special flow linetype has controls for the size and frequency of the flow arrows.
The **Draw Connections** function draws lines with arrows between the triangles for how the program has determined their flow connections.

When a triangulation file is processed by Watershed Analysis, some of the flow connection data is stored into the triangulation file to speed up reprocessing. The **Re-Process** function resets this flow connection data to start the flow calculations from scratch.

The **Detail Inspect** function reports flow connection data at the pointer position in real-time as the pointer is moved. This data includes the current position triangle number, connecting flow triangle number, sink node number, watershed name, border elevation, ridge elevation, low elevation, downstream sink number, number of source triangles, number of source nodes, current elevation and spillover elevation.

The **Watershed Inspect** function reports runoff flow data at the pointer position in real-time as the pointer is moved. The runoff data is shown in a tooltip next to the pointer and in the **Data** tab. This data has values for the overall watershed that the position is in including the sink elevation, sink name, drainage area and average slope percent. This data also has values for the watershed above the current point including the drainage area and runoff volume. Plus this data shows the elevation and runoff coefficient at the current point. When the Hatch Area Being Inspected option is active, the watershed area for the current position is hatched during inspection.
The **Watersheds Report** function runs the report formatter to choose which of the watershed parameters to report. The **Ponds Report** function reports the position and depth of each ponding area.

Besides calculating the runoff of the triangulation surface, Watershed Analysis can also process the runoff effects from structures for inlets, storage ponds, culverts and channels. The structures in Watershed Analysis are simply for placement and watershed delineation. These structures do not have design considerations for parameters like pipe size. In the **Structure** tab, there is a list of the structures to apply with the current surface. The list shows the name, type and drainage area for each structure. The Draw function will draw symbols for each structure. The Inlet structures act as sinks in the watershed and capture all the flow that comes to the inlet point. Each inlet is defined by a single point and a name. The Storage Tank structures also act as sinks and are defined by a single point and name. The Culvert structures route the flow from the culvert inlet to the outlet. The culverts are defined by two points for the inlet and outlet and by a name. The Channel structure is the same as the Culvert except that it can have more than two points to define the flow path. The structure data can be stored to a Watershed Structure File (wst) using the **Save** button. The **Load** button can read the structure data from either a wst file or from a sewer network file (.sew).

**Pulldown Menu Location:** Watershed  
**Keyboard Command:** watershed  
**Prerequisite:** Triangulation File
Run Off Tracking

This command draws 3D polylines starting at user picked points downhill until they reach a local minimum or the end of the grid or TIN. In effect it simulates the path of a rain drop. The surface is modeled by a grid file as created by Make 3D Grid File or a triangulation file created by Triangulate & Contour. The program also reports the horizontal and slope distances, average slope, maximum slope, and vertical drop. These values can be used for time of concentration calculations. Runoff tracking is a convenient way to identify distinct watershed areas and is an alternative to the automated Watershed Analysis command.

Prompts

Enter the run off path layer <RUNOFF>: press Enter
Select Surface Model dialog box
Choose the grid file or triangulation file that models the surface. If a grid is selected, it will prompt:
Extrapolate grid to full grid size (Yes/<No>)? Yes If the limits of the surface data doesn't cover the entire grid area, then the values for the grid cells beyond the data limit must be extrapolated in order to compute slopes in that area. This prompt only appears if there are grid cells without values.
Local pond spillover depth <4.80>: press Enter This allows the runoff line to continue past flat or low points in the grid or TIN, by allowing these area to fill up with water, in essence, up to the specified depth, thus letting the runoff polyline continue on.
Draw tracking for all grid cells or pick individuals [All/<Pick>]: press Enter Pressing Enter leads to individual picking of runoff tracking lines, while A for All would fill draw runoff polylines starting from each grid cell or each triangulation triangle.
Pick origin of rain drop: pick a point at the top of the run off polyline
Pick origin of rain drop (Enter to end): press Enter

Pulldown Menu Location: Watershed
Keyboard Command: runoff
Prerequisite: A .grd file created by Make 3D Grid File or a .flt (TIN) file created by Triangulate & Contour.

3D Polyline Flow Values

This command simply reports the horizontal and slope distances, vertical drop, maximum slope, and average slope of 3D polylines. The 3D polylines may be created by the Watershed Analysis or Run Off Tracking commands. The reported values could be applied to the Time of Concentration routine.
Prompts

Select 3D polyline flow line: pick a 3D polyline
Horiz dist: 217.96, Slope dist: 219.08, Vertical drop: 19.22
Average slope: 8.82%, Maximum slope: 17.68%
Select 3D polyline flow line or Enter to end: press Enter

Pulldown Menu Location: Watershed
Keyboard Command: flowvals
Prerequisite: 3D polyline

Rainfall Frequency and Amount

This command allows you to view rainfall maps while entering the rainfall amount to be used by other hydrology commands. First choose a storm and duration from the list. Then choose your location from the state list or pick your location on the map. You can enter the rainfall amount in the box in the lower left or pick your location on the map.

Reference maps based on TP-40 and TP-47 are provided for all fifty states for the different storm intervals. You can also setup user-defined lookup tables for up to five areas. For each area, you can specify a name and rainfall amounts for each storm interval. The first time the you select a user-defined storm interval, the rainfall amount will be blank. Enter in the rainfall amount and the next time that interval is selected, your entered value will be there. All rainfall amounts are in inches. The user-defined values are stored in a file called rainmap.ini in the Carlson USER directory.

Sub-Watersheds By Land Use

This command divides land-use polylines into closed polylines within a watershed polyline. The closed land-use polylines inside the watershed can then be used to determine the area of each land-use for the watershed. The Curve Numbers & Runoff command has an option to select closed polylines for determining the weighted average curve number from the polyline areas.
**Prompts**

Select closed polyline of watershed: *pick the polyline*
Select land-use closed polylines.
Select objects: *pick the polylines*

**Pulldown Menu Location:** Watershed
**Keyboard Command:** landarea
**Prerequisite:** Closed polylines for the watershed and land-use areas.

---

**Curve Numbers & Runoff**

This command calculates the weighted curve number (CN) as used by the SCS Method of runoff calculation. It will also calculate total, potential runoff from an area. The curve number is used by routines based on the TR-55 program. The weighted curve number is a weighted average of the curve numbers for each subarea of the watershed. The weights are based on the areas. The Description and Soil Type fields are used in the report. Shown here is the Curve Number Library from which to select curve numbers. The initial Curve Number Library is taken from the SCS TR-55, Urban Hydrology for Small Watersheds. You can modify the library using the New and Edit buttons and you can use the Load and SaveAs buttons to store the library to separate .rcn files.

First highlight a row on the spreadsheet, and then select the curve number from the library using the Select CN button and click on the Select Subarea button to select all the subarea closed polylines. These polylines can be generated by the Sub-Watershed by Land Use command. The program will sum the polylines that are selected for a total area. The Subarea By Interior Point button allows you to select subarea closed polylines by picking inside the polylines. If you have the runoff layers defined for the watershed beforehand, you can simplify the process by selecting the closed polyline of the whole watershed, the subareas and their curve numbers, soil types, cover descriptions as well as area values will be filled into the spreadsheet automatically.

When all the land-use curve numbers and areas are entered, enter the rainfall for the storm in question and then click on the Calc button to calculate the weighted curve number and the runoff given the weighted curve number. This curve number can then be used in the Time of Concentration and Peak Flow commands. The Runoff Volume equals the Runoff Q times the total area. You can also save the table entries to a curve number (.cn) file and reload these...
values later.

A typical Report is shown here:

Pulldown Menu Location: Watershed
Keyboard Command: curveno
Prerequisite: None
Calculate C-Factor

The C-Factor is the C in the \( Q = CIA \) (quantity of flow = C * Intensity of Runoff * Area). This is known as the Rational Method of peak flow calculation, and is often used in smaller, urban areas, as opposed to the SCS Method which involves curve numbers (CN), and typically applies to agricultural and rural settings. However, both methods are used for flow calculations for all varieties of applications. The C factor is a maximum of 1 if all the water runs off (e.g. from a non-porous surface). C factors are very low for wooded, leafy, flat terrain (water is absorbed into the ground). For a site of mixed use, with roads, houses, driveways, lawns and woods, it is necessary to compute the net C factor as a weighted C factor based on the respective areas of distinct surface types. This routine calculates the weighted C factor by permitting selections of C-Factors and polylines, as shown in the dialog here:

![C-Factor Calculation dialog](image)

Referring to the subdivision drawing shown here, first select a C factor for a category from the C-Factor library by clicking on the Select C-Factor button, the C-Factor and subarea description will be filled automatically, and then click on the Select Subarea button to select all closed polylines of the areas for this category, to complete the highlighted entry. Repeat the process for other categories of the subareas. You can also enter all values manually. If you have the runoff layer defined for the watershed beforehand, you can simplify the process by selecting the closed polyline for the whole watershed, the subareas and their C-Factor as well as area values will be filled into the spreadsheet automatically. After entering all information, click on the Calc CF button to see the result. Clear button allows you to clear the spreadsheet for entering new data. Report button reports the subarea information and the C-Factor result.
Subdivision Drawing

C-Factor Report

Pulldown Menu Location: Watershed > Calculate C-Factor
Keyboard Command: calc_cfactor
Prerequisite: None
Time of Concentration - SCS Method

This command calculates the time of concentration (Tc) by the SCS method from A Method of Estimating Volume and Rate of Runoff in Small Watersheds. The Tc is the time required for water to flow from the most distant point in the watershed to the measurement point.

The SCS method calculation is based on the curve number, length of flow, and average slope. The curve number defaults to the weighted curve number from the Curve Numbers & Runoff routine. When the three inputs are entered, click on Calculate to compute the Tc. Select CN from Table button opens the CN dialog and allows you to select the CN based on the drainage area type and the soil type. Click on Select Flow Line from Screen button to use a 3D polyline in the drawing. This sets the length of flow and average land slope. A 3D polyline that models the flow can be created with the Watershed Above Point or Run Off Tracking commands. While reading in the 3D polyline, the Tc is calculated by adding the Tc’s for each segment of the polyline. This yields a different and more accurate Tc than using the average slope with the Calculate button.

**Time of Concentration Dialog**

*Pulldown Menu Location:* Watershed -> Time of Concentration > SCS Method

*Keyboard Command:* flowtc2

*Prerequisite:* None

Time of Concentration - TR-55 Method

This command calculates the time of concentration (Tc) by the TR-55 method. Time of concentration is the time required for water to flow from the most distant point in the watershed to the measurement point.

The TR-55 method divides the flow into sheet, shallow concentrated and channel types, and Tc is computed by summing all the travel times for consecutive components of the drainage conveyance system. You can have any number of each of the three types of flow: Sheet, Shallow and Channel. For example, you could have two different channel flows in case you had two different types of channels in series. Use the Add button to add flows. You can add Sheet, Shallow and Channel flows individually or all together.

When adding a flow, the Select Flow Line From Screen function allow you to pick a 3D polyline and split it into segments of sheet, shallow and channel flow precisely. The Manning’s n for the sheet and channel flow can be chosen from a table by clicking the Select button. Clear button will clear all fields in the dialog for entering new data.

**Chapter 7. Hydrology Module** 1641
Chapter 7. Hydrology Module
Pulldown Menu Location: Watershed -> Time of Concentration > TR-55 Method

Keyboard Command: flowtc

Prerequisite: None

Time of Concentration - Rational Method

This command calculates the time of concentration (Tc) by the Rational method. The Tc is the time required for water to flow from the most distant point in the watershed to the measurement point.

The Rational method calculation based on the runoff coefficient, length of flow and average slope. These
values are set in the dialog shown. The formula is:

\[ T_c = \frac{(1.8(1.1 - c)L^{1/2})}{S^{0.33}} \]

Where: 
- \( c \) = Runoff coefficient
- \( L \) = flow length (ft or m)
- \( S \) = average land slope (%)
Peak Flow Dialog

**Pulldown Menu Location:** Watershed -> Time of Concentration > Kirpich Method

**Keyboard Command:** `flowtc4`

**Prerequisite:** None

---

**Peak Flow - Graphical Method**

This command calculates peak flow using the graphical method from the TR-55 program. The program is run through the dialog shown below. The inputs in the top section default to the values from the Curve Numbers & Runoff and Time of Concentration routines. When all the inputs are entered, click on the Calculate button to obtain the peak flow at the bottom line. The peak flow value can then be used for Detention Pond Sizing or Channel Design.

---

Graphical Peak Discharge

**Project:** Parking  
**By:** TW  
**Date:** 11/13/95  
**Location:** West  
**Checked:** Date:  
**Developed**  
**1. Data:**

Drainage area:....................A = 27.1500 Acres
Peak Flow - Tabular Hydrograph Method

This command calculates peak flow using the tabular hydrograph method from the TR-55 program. The program is run through the dialog shown below. The Curve Numbers & Runoff and Time of Concentration routines can be used to calculate the subarea input values. When all the inputs are entered, click on the Calculate button. The input values can be saved to a file by clicking the Save button. Then the Load button can be used later to recall these entered values. The peak flow report lists the flow for each subarea at different time. The peak flow value is listed at the end of the report. This value can then be used for Detention Pond Sizing or Channel Design.

See the TR-55 manual for more details on this routine. One difference between Carlson and the TR-55 example is that Carlson interpolates the flow for the subarea Ia/P between the two nearest table Ia/P values whereas TR-55 uses the one closest Ia/P table entry. Consider a subarea with an Ia/P value of 0.14 and table entries of 100 cfs at 0.1 Ia/P and 75 cfs at 0.3 Ia/P. TR-55 would use 100 cfs from the nearest 0.1 Ia/P entry. Carlson would interpolate between 100 and 75 cfs resulting in 95 cfs.
<table>
<thead>
<tr>
<th>Time</th>
<th>11.0</th>
<th>11.3</th>
<th>11.6</th>
<th>11.9</th>
<th>12.0</th>
<th>12.1</th>
<th>12.2</th>
<th>12.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subarea Discharge (cfs)</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>7</td>
<td>7</td>
<td>8</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>4</td>
<td>6</td>
<td>7</td>
<td>10</td>
<td>11</td>
<td>11</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>6</td>
<td>8</td>
<td>11</td>
<td>15</td>
<td>18</td>
<td>24</td>
<td>34</td>
</tr>
<tr>
<td>Total</td>
<td>17</td>
<td>23</td>
<td>30</td>
<td>40</td>
<td>45</td>
<td>53</td>
<td>65</td>
<td>87</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th>12.4</th>
<th>12.4</th>
<th>12.6</th>
<th>12.7</th>
<th>12.8</th>
<th>13.0</th>
<th>13.2</th>
<th>13.4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subarea Discharge (cfs)</td>
<td>1</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>6</td>
<td>7</td>
<td>7</td>
<td>9</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>11</td>
<td>13</td>
<td>16</td>
<td>20</td>
<td>26</td>
<td>48</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>16</td>
<td>19</td>
<td>23</td>
<td>29</td>
<td>39</td>
<td>74</td>
<td>127</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>75</td>
<td>104</td>
<td>137</td>
<td>165</td>
<td>184</td>
<td>202</td>
<td>173</td>
</tr>
<tr>
<td>Total</td>
<td>114</td>
<td>149</td>
<td>189</td>
<td>230</td>
<td>267</td>
<td>345</td>
<td>406</td>
<td>475</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th>13.6</th>
<th>13.8</th>
<th>14.0</th>
<th>14.3</th>
<th>14.6</th>
<th>15.0</th>
<th>15.5</th>
<th>16.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subarea Discharge (cfs)</td>
<td>1</td>
<td>5</td>
<td>6</td>
<td>8</td>
<td>17</td>
<td>38</td>
<td>85</td>
<td>134</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>6</td>
<td>8</td>
<td>13</td>
<td>27</td>
<td>56</td>
<td>101</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>20</td>
<td>39</td>
<td>65</td>
<td>96</td>
<td>91</td>
<td>59</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>28</td>
<td>54</td>
<td>96</td>
<td>161</td>
<td>185</td>
<td>147</td>
<td>82</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>143</td>
<td>156</td>
<td>152</td>
<td>126</td>
<td>97</td>
<td>67</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>234</td>
<td>257</td>
<td>253</td>
<td>213</td>
<td>166</td>
<td>116</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>107</td>
<td>85</td>
<td>69</td>
<td>52</td>
<td>41</td>
<td>31</td>
<td>25</td>
</tr>
<tr>
<td>Total</td>
<td>544</td>
<td>606</td>
<td>654</td>
<td>692</td>
<td>674</td>
<td>608</td>
<td>516</td>
<td>397</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Time</th>
<th>16.5</th>
<th>17.0</th>
<th>17.5</th>
<th>18.0</th>
<th>19.0</th>
<th>20.0</th>
<th>22.0</th>
<th>26.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subarea Discharge (cfs)</td>
<td>1</td>
<td>94</td>
<td>64</td>
<td>46</td>
<td>35</td>
<td>25</td>
<td>19</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>59</td>
<td>39</td>
<td>28</td>
<td>22</td>
<td>16</td>
<td>13</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>13</td>
<td>11</td>
<td>10</td>
<td>9</td>
<td>7</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>33</td>
<td>27</td>
<td>23</td>
<td>21</td>
<td>17</td>
<td>15</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>25</td>
<td>21</td>
<td>18</td>
<td>16</td>
<td>13</td>
<td>12</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>46</td>
<td>39</td>
<td>33</td>
<td>30</td>
<td>25</td>
<td>22</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>18</td>
<td>16</td>
<td>15</td>
<td>13</td>
<td>12</td>
<td>11</td>
<td>8</td>
</tr>
<tr>
<td>Total</td>
<td>289</td>
<td>217</td>
<td>173</td>
<td>146</td>
<td>115</td>
<td>99</td>
<td>74</td>
<td>39</td>
</tr>
<tr>
<td>Peak Discharge: 692 cfs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Pulldown Menu Location: Watershed
Keyboard Command: peakflow
Prerequisite: None

Peak Flow - Rational Method (General)

This command calculates peak flow using the rational method, Q=CIA. The program is run through the dialog shown below. Depending on your area, there are different methods for determining the Intensity of Rainfall which you will need to know for this routine. The weighted Runoff Coefficient or C-factor can be calculated by the Curve Number & Runoff routine. The peak flow value can then be used for Detention Pond Sizing or Channel Design.

Peak Flow Rational Method Report:

Rational Peak Discharge
Project: Parking  By: TW  Date: 11/13/95
Location: West  Checked:  Date:
Developed
1. Data:
   Drainage area:.........A = 27.1500 Acres
   Weighted Runoff Coefficient:....C = 0.400
   Intensity of Rainfall:.........I = 2.10 in/hr
2. Peak Discharge:.........cfs = 22.8060
Peak Flow - Rational Method (Riverside S. California)

This command is design to compute peak flow in the Riverside County, southern California. In Riverside county as well as Southern California, peak flow is calculated based on the Rational method, \( Q = CIA \), but it also has its own computing criteria because of its extremely varied topography, soil types and land uses, and its storm events that are different than other regions.

First, Riverside County usually requires a peak flow calculation on 10-year and 100 year storm events. So rainfall data of riverside county should be defined in the rainfall library. We provide two methods, Rainfall Accumulation and Rainfall Intensity, which allows any combination of return periods of 2-year, 5-year, 10-year, 25-year, 50-year and 100-year rainfall definition. IDF curves would be calculated. Second, Riverside County defines a list of land development types, which affect the subarea runoff index and percentage of the impervious cover, and therefore lead to the calculation of the time of concentration, rainfall intensity, runoff coefficient and then peak flow. The types of land development are: Commercial, Apartment, Mobil home park, Condominium, Single family(1/4 Acre lot, 1/2 Acre lot, 1 Acre lot), Undeveloped with poor, fair or good cover. Please refer to the Riverside County Hydrology Manual for details.

Select Rational Method (Riverside County) from Watershed > Peak Flow menu. In the peak flow dialog, choose a rainfall from the rainfall library, and specify the return period and the antecedent moisture condition. The spreadsheet displays the list of drainage area data in design. Add Drainage Area button allows you to add a new drainage entry, Edit Drainage Area button allows you to edit the highlighted entry and Remove Drainage Area button removes the highlighted entry. When you add or edit a drainage area, the Add/Edit Drainage Area dialog opens. Enter the drainage area name, specify the soil type and cover type from a look up table, and choose the land development type. The area can be entered either manually or automatically by selecting a closed polyline from screen. The flow line data can also be obtained from picking a 3D polyline and the program calculates the length and slope of the flow automatically. Click on OK button to commit the drainage area entry.

The design data can be saved to a .riv file, and loaded back to the dialog. Report button reports the design data and hydrology calculation results. The Use Report Formatter option allows you to report data to a spreadsheet instead.
Prompts

Peak flow dialog: Fill in values

Pulldown Menu Location: Watershed -> Peak Flow > Rational Method (Riverside County, S. California)
Keyboard Command: peakflw5
Prerequisite:

Peak Flow - Rational Method (KYDOT)
This command calculates peak flow using the rational method, Q=CIA, with rainfall intensity coefficients specific to regions of Kentucky. The program is run through the dialog shown below. The weighted Runoff Coefficient or C-factor can be calculated by the Curve Number & Runoff routine. The peak flow value can then be used for Detention Pond Sizing or Channel Design.

Pulldown Menu Location: Watershed
Keyboard Command: peakflw2
Prerequisite: None
Watershed Settings (Save and Load)

These commands save and load watershed parameters to a data file with a .HYD file name extension. The watershed values include settings from the commands in the top portion on the Watershed menu such as rainfall, storm type, weighted curve number. These commands allow you to recall these values after reloading the drawing at a later time.

Pulldown Menu Location: Watershed
Keyboard Commands: saveshed, loadshed
Prerequisite: none

Runoff Hydrograph - SCS Method

This function applies the SCS hydrograph procedure and the same methodology as used in TR-20 to generate runoff hydrograph by specifying either a triangular hydrograph shape or a curvilinear one. The SCS method is best suited for large watersheds.

SCS Curvilinear method uses the dimensionless unit hydrograph developed by Victor Mockus. This dimensionless hydrograph has its ordinate values expressed in a dimensionless ratio Q/Qp (discharge at time t to total discharge) or Qa/Q (accumulated volume at time t to total volume) and its abscissa values as T/Tp (time t to peak time). When calculating the unit hydrograph for certain watershed, ∆D, the internal calculation increment, is 0.1333Tc for each given subarea. Slightly adjust ∆D so that Tp on the unit hydrograph will fall exactly on one of the ordinates spaced at ∆D. This method creates the unit hydrograph for one inch of direct runoff using the 51 evenly spaced Q/Qp ratios used internally by TR-20.

SCS Triangular method uses an equivalent triangular hydrograph having the same units of time and discharge to represent the dimensionless curvilinear unit hydrograph. Please refer to National Engineering Handbook Section 4 for the equations used in generating both SCS Curvilinear and SCS Triangular unit hydrograph.

Select SCS Method from Watershed > Hydrograph Routing > Watershed Hydrograph menu. This command opens a dialog for hydrograph calculation. First choose which method to use, SCS Curvilinear or SCS Triangular. Then enter the sub-basin and rainfall data. When creating an SCS Triangular unit hydrograph, you need to enter the unit hydrograph peak attenuation factor, which controls the area under the unit hydrograph before the time to peak. Usually a factor of 484 is used. This factor varies from about 600 in steep terrain to 300 in very flat swampy areas. When creating an SCS Curvilinear unit hydrograph, the peak attenuation factor is default to 484.

After entering all information, click Calculation button to generate the unit and runoff hydrograph. Unit Hydrograph button and Runoff Hydrograph button open a dialog with the tabular and graphic data of the unit and runoff hydrograph correspondingly, from there you can draw the hydrograph on screen, generate the hydrograph data in the report format and save the hydrograph to a file.
Runoff Hydrograph - SCS Method

Unit Hydrograph Dialog
Runoff Hydrograph - TR-55 Tabular Method

The TR-55 Tabular Method approximates TR-20, which is a more detailed hydrograph procedure. This method can develop partial composite runoff hydrographs at any point in a watershed by dividing the watershed into homogeneous subareas. The tabular discharge values for the various rainfall distribution, presented in TR-55, Urban Hydrology for Small Watersheds (U.S. Soil Conservation Service), are used in this method. Tabular discharges expressed in csm/in are given for a range of subarea Tc's from 0.1 to 2 hours and reach Tt's from 0 to 3 hours.

Select TR-55 Tabular Method from Watershed > Hydrograph Routing > Watershed Hydrograph menu. This command opens a dialog for hydrograph calculation. Choose the area unit and select the appropriate storm type for the project location. See the storms maps in the TR-55 manual to determine the storm type. Enter the rainfall depth for the watershed. Select the Ia/P Interpolation option to interpolate the Ia/P ratio, otherwise the calculated Ia/P value would be rounded to the constants 0.10, 0.30 or 0.50. Next, enter the watershed data in the spreadsheet. In the Subarea Name column, enter a short name for each subarea, using numbers or letters. In the Area column, type the area value. You can also click the Select Area button on the bottom of the spreadsheet to calculate the drainage area by selecting a closed polyline.

In the Tc (time of concentration) and Tt (Travel Time) columns, enter the corresponding values. Tt specifically refers to the total time for water to flow from a subarea's outfall to composite outfall point. When the Tc value for a particular subarea doesn't exist in the tabular hydrograph for the given distribution, it will be rounded off in order to determine which hydrograph table to read from. Please refer to Tr-55 for the method used for rounding off Tc and Tt values.

In the Downstream Subarea Name column, type the list of the names of the downstream subareas. Separate each name with a comma. In the CN (Runoff Curve Number) column, enter the CN value of the subarea. Insert Row and Delete Row buttons allow you to do the spreadsheet editing. You can also load a runoff tabular file that you previously saved by clicking on Load button, and save current calculation by Save and SaveAs buttons. The data is stored in a .tab file.
After entering all information, click on Calculation button to generate the runoff hydrograph. Runoff Hydrograph button opens a dialog with the tabular and graphic hydrograph data, from there you can draw the hydrograph on screen and save it to a file.

**Runoff Hydrograph - TR-55 Tabular Method**

**Pulldown Menu Location:** Watershed > Hydrograph Routing > Watershed Hydrograph > TR-55 Tabular Method

**Keyboard Command:** runoffhyd2

**Prerequisite:** None

---

**Runoff Hydrograph - Rational Method**

The Rational Method is intended for modeling one runoff node, represented by a weighted runoff coefficient and total watershed area. The Rational Hydrograph can be created using one of four methods. They are Modified Rational, Dekalb Rational, Universal Rational and User Defined Rational. All four methods require a predefined IDF curve and the time of concentration to determine the peak flow using the Rational formula.

The Modified Rational method assumes the time of concentration is also the time of peak for the hydrograph. For a duration greater than the time of concentration, this method creates a trapezoidal shaped hydrograph. You may also apply a Receding Limb Factor in order to changed the slope of the receding limb. The default factor value is 1.
The Deltalb Rational method uses the Modified Rational method as its foundation. Peak discharge is computed using the Rational formula, then the time to peak and the time of base are adjusted to five and ten times the time of concentration. Ten discharge values at increments of time of concentration are computed by scaling the peak discharge appropriately according to the following template.

<table>
<thead>
<tr>
<th>T/Tc</th>
<th>Q/Qp if Tc &lt; 20.0 min</th>
<th>Q/Qp if Tc ≥ 20.0 min</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0.16</td>
<td>0.04</td>
</tr>
<tr>
<td>2</td>
<td>0.19</td>
<td>0.08</td>
</tr>
<tr>
<td>3</td>
<td>0.27</td>
<td>0.16</td>
</tr>
<tr>
<td>4</td>
<td>0.34</td>
<td>0.32</td>
</tr>
<tr>
<td>5</td>
<td>1.00</td>
<td>1.00</td>
</tr>
<tr>
<td>6</td>
<td>0.45</td>
<td>0.30</td>
</tr>
<tr>
<td>7</td>
<td>0.27</td>
<td>0.11</td>
</tr>
<tr>
<td>8</td>
<td>0.19</td>
<td>0.05</td>
</tr>
<tr>
<td>9</td>
<td>0.12</td>
<td>0.03</td>
</tr>
<tr>
<td>10</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>

The Universal Rational method uses multiples of predefined coefficients (see the following table) and the peak discharge to compute ordinates at different times. Peak discharge is assumed to be reached at a time equal to three times the time of concentration. The time of base of the hydrograph is computed as eleven times the time of concentration.

<table>
<thead>
<tr>
<th>Time (min)</th>
<th>Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.0</td>
</tr>
<tr>
<td>Tc</td>
<td>0.21Qp</td>
</tr>
<tr>
<td>2Tc</td>
<td>0.30Qp</td>
</tr>
<tr>
<td>3Tc</td>
<td>Qp</td>
</tr>
<tr>
<td>4Tc</td>
<td>0.54Qp</td>
</tr>
</tbody>
</table>
The User Defined Rational method is similar to the Dekalb Rational method and the Universal Ration method, but with different templates provide by users. This method computes a hydrograph by using a dimensionless hydrograph template that has values for T/Tc versus Q/Qp.

Select Rational Method from Watershed > Hydrograph Routing > Watershed Hydrograph menu. This command opens a dialog for hydrograph calculation. First choose what method to use, then enter the sub-basin and rainfall data. The IDF curves will be computed after you choose a rainfall from the rainfall library. When use the User Defined Ration method, you will need to define the Q/Qp template.

After entering all information, click Calculation button to generate the runoff hydrograph. Runoff Hydrograph button opens a dialog with the tabular and graphic data, from there you can draw the hydrograph on screen and save the hydrograph data to a file.

### Runoff Hydrograph - Rational Method

**Pulldown Menu Location:** Watershed > Hydrograph Routing > Watershed Hydrograph > Rational Method  
**Keyboard Command:** runoffhyd3  
**Prerequisite:** None

### Pipe Routing Hydrograph

Pipe routing transforms a sub-basin runoff hydrograph from the point of discharge in the pipe to a downstream location. As the hydrograph flows to the downstream area it undergoes changes in shape and distribution due to translation and reach storage effects. This program implements the Storage-Indication methodology, which
accounts for storage effects and is derived from the continuity equation:

\[ \Delta S/\Delta t = I - O \]

Where:
- \( \Delta S \) = Change in storage (cubic ft or cubic meter)
- \( \Delta t \) = Routing time step (hours)
- \( I \) = Inflow discharge (cfs of cms)
- \( O \) = Outflow discharge (cfs of cms)

Please refer to the National Engineering Handbook Section 4 for the detail of the Storage-Indication method.

Select Pipe Routing from Watershed > Hydrograph Routing menu. This command opens a dialog for hydrograph routing. First, select the inflow hydrograph file. Second, either design a pipe or enter the stage-storage and stage-discharge data of a known pipe. When design a pipe, enter pipe parameters in the pipe design dialog, the headwater and tailwater elevations are also need to be specified for stage-discharge calculation. If the pipe is known, select its stage-storage and stage-discharge files, and then specify the pipe length and its section area for calculating flow travel time.

The numerical accuracy and stability of pipe routing is sensitive to the routing interval \( \Delta t \). The average reach travel time is computed by dividing the flow velocity corresponding to the average discharge for the inflow hydrograph into the pipe. If the travel time is less than the time interval, then negative outflow could occur and the calculation is not accurate and the program generates a warning message asking for a smaller routing interval.

After entering all information, click Routed Hydrograph button to generate the routing hydrograph. A dialog is opened with the tabular and graphic hydrograph data, from there you can draw the hydrograph on screen and save it to a file.
Pipe Routing - Pipe Design Dialog

Routed Hydrograph Dialog

Pulldown Menu Location: Watershed > Hydrograph Routing > Pipe Routing

Keyboard Command: piperrout

Prerequisite: None

**Reservoir Routing Hydrograph**

Reservoir routing is used to determine the peak flow attenuation that a hydrograph undergoes as it enters a reservoir. A reservoir is defined by a stage-storage curve and a stage-discharge curve, which can be entered or computed using commands in the Structure pull-down menu. A runoff hydrograph travels through the reservoir to an outlet. The outflow hydrograph is calculated by Storage Indication method, which is developed from the continuity equation:

\[ \Delta S/\Delta t = I - O \]

Where: \( \Delta S \) = Change in storage (cubic ft or cubic meter)
Please refer to the National Engineering Handbook Section 4 for the detail of the Storage-Indication method.

Select Reservoir Routing from Watershed > Hydrograph Routing menu. This command opens a dialog for hydrograph routing. First, select the runoff hydrograph file that you want to do the reservoir routing. Second, select the stage-storage and stage-discharge curve files of a known reservoir. Then specify the initial water elevation at the time when the routing starts and the routing interval. When the routing interval is too large, negative outflows can occur and the program would prompt a error message asking for a smaller interval.

After entering all information, click Routed Hydrograph button to generate the routing hydrograph. A dialog is opened with the tabular and graphic hydrograph data, from there you can draw the hydrograph on screen and save it to a file.
Channel Routing Hydrograph - Convex Method

Channel routing is used to analyze the effects of a channel on a hydrograph's peak flow and travel time. You may choose from either the Convex or Modified Att-Kin methods to route a hydrograph downstream.

The Convex method is derived from inflow-outflow hydrograph relationships. The following equation is used:

\[ O_{i+1} = C I_i + (1 - C)O_i \]

where: \( O_{i+1} \) = Outflow discharge at \((i+1)\)th time step (cfs or cms)
\( C \) = Routing Coefficient
\( I_i \) = Inflow discharge at \(i\)th time step (cfs or cms)
\( O_i \) = Outflow at \(i\)th time step (cfs or cms)

The routing coefficient \( C \) can be computed using an empirical equation by SCS.

\[ C = \frac{V}{V + 1.7} \] for English units
\[ C = \frac{V}{V + 0.518} \] for Metric units

where: \( V \) = Flow velocity (ft/s or m/s)

Please refer to the National Engineering Handbook Section 4 for the detail of the Convex method.

Select Convex Method from Watershed > Hydrograph Routing > Channel Routing menu. Specify the inflow hydrograph and enter the routing coefficient \( C \) or channel flow velocity to let the program to calculate the coefficient. The routing interval is as same as the time increment of the inflow hydrograph.
After entering all information, click on Routed Hydrograph button to generate the routing hydrograph. A dialog is opened with the tabular and graphic hydrograph data, from there you can draw the hydrograph on screen and save it to a file.

Channel Routing Hydrograph - Convex Method

**Channel Routing Hydrograph - Modified Att-Kin Method**

Channel routing is used to analyze the effects of a channel on a hydrograph's peak flow and travel time. You may choose from either the Convex or Modified Att-Kin methods to route a hydrograph downstream.

The Modified Att-Kin (attenuation-kinematic) method is used in the TR-20 and TR55 methodologies. It is a combination of the storage indication method and the kinematic wave method to reflect the reservoir and translation effects on natural flood waves. The hydrograph is first routed through a reservoir assuming that the outflow is proportional to the storage. The resulting outflow hydrograph is then translated using kinematic wave principles. The storage routing portion allows for attenuation and translation. Kinematic routing translates the outflow
hydrograph but doesn't attenuate the peak.

The continuity equation is

\[ I_i - (O_{i+1} - O_i) / 2 = (S_{i+1} - S_i) / \Delta t \]

where:  
- \( I_i \) = Inflow hydrograph discharge at (i)th time step  
- \( O_i \) = Outflow hydrograph discharge at (i)th time step  
- \( O_{i+1} \) = Outflow hydrograph discharge at (i+1)th time step  
- \( S_i \) = Storage at (i)th time step  
- \( S_{i+1} \) = Storage at (i+1)th time step  
- \( \Delta t \) = Routing time step

Substitution of \( S = KO \) leads to

\[ O_{i+1} = C_m I_i + (1 - C_m)O_i \]

where:  
- \( C_m = 2\Delta t/(2K + \Delta t) \)  
- \( K = L / (60mV) \)  
- \( V = Q / A \)  
- \( A = (Q / x)^{1/m} \)

where:  
- \( L \) = Channel length (ft or meter)  
- \( V \) = Average velocity in the channel (ft/s or m/s)  
- \( Q \) = Average channel flow, default value is the peak discharge of the inflow hydrograph (cfs or cms)  
- \( A \) = Wet cross section area of the channel (sq. ft or sq. meter)  
- \( x \) = Flow equation multiplier, \( > 0.0 \)  
- \( m \) = Flow equation exponent, default value is \( 5/3 \), usually is \( 1.0 <= m <= 2.8 \)

The coefficient \( x \) can be estimated using Manning's Formula:

\[ x = S^{1/2} / nP^{2/3} \]

where:  
- \( S \) = Average slope of the channel  
- \( n \) = Manning’s n value  
- \( P \) = Wetted perimeter of the flow (ft or m)

Please refer to the TR-66 for the detail of the Modified Att-Kin method.

Select Modified Att-Kin Method from Watershed > Hydrograph Routing > Channel Routing menu. Specify the inflow hydrograph and enter the channel length, the routing coefficient \( x \) and the time coefficient \( m \). The routing interval is as same as the time increment of the inflow hydrograph. Button Estimate Coefficients \( x \) and \( m \) allows you to enter the parameters of the Channel to determine the \( x \) and \( m \) coefficients. Once the parameters are entered, click on the Calculate button to compute the coefficients. OK button accepts the values and proceeds to the previous dialog.

After entering all information, click Routed Hydrograph button to generate the routing hydrograph. A dialog is opened with the tabular and graphic hydrograph data, from there you can draw the hydrograph on screen and save it to a file.
Channel Routing Hydrograph - Modified Att-Kin Method

Channel Routing Hydrograph - Estimate Coefficients Dialog

Routed Hydrograph Dialog
Draw Flow Polylines TR20

This command draws polylines that represent flow lines. When drawing a network of flow lines, first draw the main branch. Then begin drawing the other flow lines from the top of flow and use the Join option to connect onto the main branch.

Draw Flow Polylines is the first command in a series that produce the watershed schematic for TR-20 Hydrograph Development. These flow polylines only represent the layout of the watershed and they do not need to be drawn to scale. After each flow polyline is drawn, the program prompts for the drainage area, curve number and time of concentration of the branch associated with that flow polyline. This data is used in the RUNOFF statement in TR-20. The flow polyline label shows the area over the curve number and time of concentration.

Note:

- Always draw the flow polylines from the highest to lowest elevation (in the direction of flow).

Prompts

Text size <4.0>: Indicate the desired text size and press Enter

Draw from highest to lowest elevation (direction of flow).

Exit/Pick point: Graphically locate the upstream end of the flow polyline

Undo/Exit/Join/Pick point: Graphically locate the next downstream location of the flow polyline and press Enter when complete

Draw another flow polyline [<Yes>]/[No]? Indicate if another flow polyline should be drawn

![Drainage Area](image.png)

Area by: Indicate the unit of area for the Drainage Area control.

Drainage Area: Indicate the area that contributes to the hydrograph or click the Select button and pick a closed polyline.

Weight Curve Number: Indicate the weighted land use curve number that determines how much surface runoff will occur.

Time of Concentration: When using the TR-20 methodology, indicate the Time of Concentration (T_c) value.
Main flow polyline with one branch and a reach

**Pulldown Menu Location(s):** Watershed → TR-20 Routing

**Keyboard Command:** trflow

**Prerequisite:** None

### Locate Structures TR20

This command places a structure on a flow polyline of the watershed schematic for TR-20 Hydrograph Development. The program prompts for elevation, discharge and storage data for the structure which is equivalent to the TR-20 STRUCT table data:

![Structure Data Table](image)

**Water Elevation at T=0:** Indicate the water-surface elevation at the structure at the beginning of the storm.

**Insert Row:** Inserts a row above the current row.

**Remove Row:** Removes the current row.

**Load:** Load a stage-discharge and/or stage-storage file into the table:

- *Stage-discharge .STG* - Stage-storage files can be created with the Design Bench Pond, Design Valley Pond or Calculate Stage-Storage commands.
- *Stage-storage .CAP* - Stage-discharge files can be created with the Drop Pipe Spillway Design, Design Channel or Design Culvert commands.

**Graph:** Description of Control.

**Report:** Produces a text report of the structure data.

**Note:**

- The TR-20 processing engine limits the number of stage-storage-discharge entries to twenty.
• The initial discharge must be zero due to the TR-20 engine.

**Prompts**

*Symbol size <4.0>*: Indicate the desired symbol size and press Enter  
*Pick location on flow polyline for structure*: Pick a point on a flow polyline and press Enter

**Pulldown Menu Location(s):** Watershed → TR-20 Routing  
**Keyboard Command:** trstruct  
**Prerequisite:** Flow polyline

---

**Locate Reach**

This command places a reach on a Flow Polyline of the watershed schematic for TR-20 Hydrograph Development. The program prompts for the reach length, end-area coefficient and exponent M. These variables are explained in the TR-20 manual. A square reach symbol that contains the reach data is drawn on the flow polyline. The reach labels show the length above the end area coefficient and exponent M.

**Prompts**

*Symbol size <4.0>*: Indicate the desired symbol size and press Enter  
*Pick location on flow polyline for reach*: Pick a location for the reach and press Enter

---

**Edit Layout Element**

This command allows you to edit the data stored with a part of the watershed schematic. For flow polylines the area, curve number and time of concentration can be changed. For structures the elevation, discharge and storage can be changed. For reaches, the length, end area coefficient and exponent M can be changed.
Prompts

Select flow line, structure or reach to edit (Enter to end): pick a flow polyline, structure symbol, or reach symbol

Pull down Menu Location: Watershed

Keyboard Command: tredit

Prerequisite: Flow polylines

Hydrograph Development

This command routes runoff through branches, structures and reaches created with the following commands:

1. Draw Flow Polylines
2. Locate Structures
3. Locate Reach

The routine supports the older and newer versions of TR-20 that are more Windows-compatible and you are prompted for storm data:

![Calculate Hydrographs window]

**Rainfall Depth:** Indicate the amount of rainfall that contributes to the hydrograph.

**Main Time Increment:** When using the TR-20 methodology, indicate the Time increment.

**Storm Type:** When using the TR-20 methodology, indicate the Storm Type that should be used for the calculations.

**Antecedent Moisture Conditions:** When using the TR-20 methodology, indicate the amount of moisture already in the soil.

**Use DELMARVA 24-Hr Dimensionless Hydrograph:** When enabled and when using the TR-20 methodology, a DelMarVa 24-hr Unit Hydrograph will be applied to the hydrograph calculations.

After the dialog, select the flow lines, structures and reaches that were created by the commands outlined above. The program then creates a TR-20 input file called temp.dat in the Carlson EXEC directory and runs TR-20. The output can be sent to a file, printer or screen from the report viewer.

![Diagram of flow lines and structures]

Hydrographs are created at each flow line junction, structure and reach. The hydrographs are stored in files with a .h1 extension. These files are named automatically and placed in the project directory. Hydrographs entering a structure start with an 'S' and then the structure number. The structure number is labeled next to the structure symbol. Hydrographs entering a junction start with a 'J' and then the junction number. The junction number is also labeled next to the junction.
The next part of the file name is either 'RUN' for runoff, 'OUT' for the hydrograph at the end of the Watershed schematic with two flow lines, one structure and two reaches to be used as input for Hydrograph Development structure, 'REA' for the end of a reach, or 'ADD' for the combination of two hydrographs. A more detailed description of the hydrograph is in the third line of the hydrograph file. The Hydrographs can then be plotted using Draw Hydrograph.

Prompts

Select flow polylines, structure and reach symbols.
Select objects: Pick the objects to be used for the hydrograph

Pulldown Menu Location(s): Watershed → TR-20 Routing
Keyboard Command: runtr20
Prerequisite: A flow polyline.

Single Runoff Hydrograph

This command creates a hydrograph for the runoff of one drainage area. The hydrograph is stored in a file with a .h1 extension that can be drawn with the Draw Hydrograph command or reported with the Report Hydrograph command.

Method: Indicate the method used for determining the hydrograph:

- SCS TP-149 - Methodology described in A Method for Estimating Volume and Rate of Runoff in Small Watersheds.

Area Units: Indicate the unit of area for the Drainage Area control.

Drainage Area: Indicate the area that contributes to the hydrograph or click the Select button and pick a closed polyline.

Rainfall Depth: Indicate the amount of rainfall that contributes to the hydrograph.

Rainfall Frequency: Indicate the statistical probability of how often the rainfall event will occur.
Runoff Curve Number: Indicate the land use curve number that determines how much surface runoff will occur.

Average Slope: When using the TP-149 methodology, indicate the average slope of the flow path.

Length of Flow: When using the TP-149 methodology, indicate the slope length of the flow path.

Time of Concentration: When using the TR-20 methodology, indicate the Time of Concentration ($T_c$) value.

Main Time Increment: When using the TR-20 methodology, indicate the Time increment.

Storm Type: When using the TR-20 methodology, indicate the Storm Type that should be used for the calculations.

Antecedent Moisture Conditions: When using the TR-20 methodology, indicate the amount of moisture already in the soil.

Use DELMARVA 24-Hr Dimensionless Hydrograph: When enabled and when using the TR-20 methodology, a DelMarVa 24-hr Unit Hydrograph will be applied to the hydrograph calculations.

Pulldown Menu Location(s): Watershed > TR-20 Routing

Keyboard Command: calchgrf

Prerequisite: None

Add Hydrographs

This function adds two hydrographs up and writes the new hydrograph to a file.

Select Add Hydrographs command from Watershed menu. This command prompts you to select two hydrograph files. They can be either of Carlson style with the file extension of .hyd, or TR-20 style with the file extension of .h1. Then the program adds up the two set of data, the time interval is the smaller one of the two hydrographs. At the end, you are asked to specify a file for the output hydrograph.

Pulldown Menu Location: Watershed > Add Hydrographs

Keyboard Command: mergehyd

Prerequisite: hydrograph files

Report Hydrograph

This command reports a hydrograph from a hydrograph file with the extension of:

- *.h1 - *.h1 files are created by SEDCAD, Hydrograph Development, or the Single Runoff Hydrograph commands.
- *.hyd - *.hyd files are created by all commands under Watershed → Hydrograph Routing menu and sewer network hydrograph routing programs.

After specifying the desired hydrograph file, the following dialog box is presented:
Hydrograph Values and Graphical Representation: The Time vs. Flow values for the hydrograph are displayed in a list and a graphical representation of the hydrograph are provided.

Peak Flow and Time: The Time to Peak ($T_p$) and Peak Discharge ($Q_p$) are provided.

Report Decimals: Indicate the desired level of Precision to be displayed in the Text Report.

Use Report Formatter: When enabled, this control displays the Report Formatter Options dialog box that gives you greater control over the content and type of report you would like to produce.

Report: Displays a hydrograph report showing Time vs. Flow values.

Draw: When clicked, a graphical representation of the hydrograph will be placed into the drawing through the functionality found in the Draw Hydrograph command.

Pulldown Menu Location(s): Watershed

Keyboard Command: viewhyd

Prerequisite: A hydrograph file

**Draw Hydrograph**

This command draws a hydrograph from a hydrograph file with the extension of:

- *.h1 - *.h1 files are created by SEDCAD, Hydrograph Development, or the Single Runoff Hydrograph commands.
- *.hyd - *.hyd files are created by all commands under Watershed > Hydrograph Routing menu and sewer network hydrograph routing programs.

After specifying the desired hydrograph file, the following dialog box is presented:
**Draw Grid:** When enabled, this option creates a grid that accompanies the hydrograph that is to be drawn. Click the **Setup** button to access the grid settings which are discussed in detail in the Draw Grid section of the Draw Profile command.

**Output to Separate Drawing:** When enabled, this option draws the hydrograph to a separate drawing. Click the **Set** button to specify the name/location of the external drawing.

**Horizontal Scale:** Specify the time interval (in hours).

**Vertical Scale:** Specify the flow (in CFS).

The **Layers, Colors, Text Styles/Sizes** and Linetypes buttons provide access to settings for each of these features of the hydrograph.

**Load Settings:** Loads a saved collection of Draw Hydrograph settings, saved in a (.PFS) file.

**Save Settings:** Saves all Draw Hydrograph settings in a (.PFS) file.

---

**Note:**

- Because the horizontal and vertical axis is typically very closely spaced in the hydrograph output files, it is recommended to set the horizontal scale to a unit factor (1) and set the vertical scale to a value of 2x or 5x the horizontal scale. For many cases, a Horizontal Scale of 1 and Vertical Scale of 5 works well for plotting. When the **Draw Grid** option is enabled, make sure its settings are consistent with the Horizontal and Vertical Scale factors.
- Multiple hydrographs can be drawn on the same grid by first running Draw Hydrograph with the Draw Grid option on. Then run Draw Hydrograph for each additional hydrograph with the Draw Grid option off.

**Prompts**

**Pick Starting Point for Grid <0.0, 0.0>:** Pick a point

**Pulldown Menu Location(s):** Watershed

**Keyboard Command:** hydrogrf

**Prerequisite:** A hydrograph file
SEDCAD Draw Flow Polylines

This command draws polylines in the SEDCAD layer that represent flow lines. When drawing a network of flow lines, first draw the main branch. Then begin drawing the other flow lines from the top of flow and use the Join option to connect onto the main branch. Draw Flow Polylines is the first command in a series that produce the Junction, Branch, and Structure labels for SEDCAD.

Prompts

End/Pick point: pick a point
Undo/End/Join/Pick point: pick a point
Undo/End/Join/Pick point: pick a point
Undo/End/Join/Pick point: press Enter
Draw another flow polyline (<Yes>/No)? press Enter
End/Pick point: pick a point
Undo/End/Join/Pick point: pick a point
Undo/End/Join/Pick point: Join
Select flow polyline at place to join: pick the main branch at the junction
Draw another flow polyline (<Yes>/No)? No

Pulldown Menu Location: Watershed > SEDCAD Structure Layout
Keyboard Command: sedcad1
Prerequisite: None

SEDCAD Locate Structures

This command is the second step for creating the SEDCAD layout. Locate Structures places triangle symbols on flow polylines that represents structures for SEDCAD.

Prompts

Symbol size <4.0>: press Enter
Pick location on flow polyline for structure: pick a point on a polyline
Pick location on flow polyline for structure: pick a point on a polyline

Pulldown Menu Location: Watershed > SEDCAD Structure Layout
Keyboard Command: sedcad2
Prerequisite: flow polylines

SEDCAD Label Structure Layout

This command is the third and final step for creating the SEDCAD layout. Label Structure Layout draws text labels for the junctions, branches, and structures in the network. A junction, branch, and structure report is also generated. Flow polylines and structure symbols must be drawn before running this routine. This command uses the labeling rules as described in the SEDCAD manual.

Prompts

Symbol size <4.0>: press Enter
Junction offset tolerance <10.0>: press Enter Flow lines that meet the main branch within this distance of each other are considered the same junction.
Select flow polylines and structure symbols.
Select objects: pick the polylines and symbols
J5,B1,S1
J4,B2,S1
Write report to file (Yes/No)? press Enter
Write report to printer (Yes/No)? press Enter

Example of labeled SEDCAD structure layout

Pulldown Menu Location: Watershed → SEDCAD Structure Layout
Keyboard Command: sedcad3
Prerequisite: flow polylines and structure symbols

SEDCAD

Civil Software Design is the author of SEDCAD, which is sold separately from Carlson. SEDCAD is a comprehensive hydrology and sedimentology package, useful for all varieties of runoff and sediment control design calculations. SEDCAD can be run directly from the Carlson Hydrology menu. The directory where SEDCAD is installed must be defined in the Carlson Configure command.

Pulldown Menu Location(s): Watershed → SEDCAD Structure Layout
Keyboard Command: sedcad
Prerequisite: Installed and licensed version of SEDCAD

Prepare HEC-RAS Input File

This program reads cross-section files and the corresponding MXS files (please see the material on Sections in Chapter 6 of this manual) and creates input files that can be used to run the HEC-RAS program for river analysis.
The HEC-RAS program could be considered to be an advanced Windows-based version of the HEC-2 program. This program makes it easier for CADD and GIS systems to import their data directly for river network analysis. It is also very convenient because the output from the program can be exported directly to CADD programs where this data can be used to create water surface models for inundation mapping.

Data Format

HEC-RAS input files consist of three data sections:

* A header, containing data relevant to all sections of the data in the file.
* A description of the stream network, containing reach locations and connectivity.
* A description of the model cross-sections, containing cross-section location and geometric data as well as additional HEC-RAS modeling information.

The header information is mainly for the purpose of identifying the project and is mostly not used by the program. The only important information needed by the program is the "Units" section and the value must be "ENGLISH" or "METRIC".

The network is modeled as a set of interconnected streams. Each stream is a set of interconnected reaches. Each reach, hence, MUST have a unique Stream ID and Reach ID.

The Stream Network section contains a series of Point Numbers and the corresponding coordinates. In addition, this section has information pertaining to each Reach. For each Reach, the following information is provided:

* Stream ID and Reach ID. These are 16 character alphanumeric strings. Together these two items uniquely identify a Reach.
* Starting (FROM or upstream) point and ending (TO or downstream) point of the Reach. The FROM point and TO point here are given by their Point Numbers, as identified above.
* The coordinates on the Centerline of the Reach, starting with the FROM point coordinates and ending with the TO point coordinates.

The Cross-Sections portion of the input file contains data describing the geometric properties at each cross section in the network. The following information is provided at each Cross-Section:

* Stream and Reach ID, to identify which Reach the Cross-Section is on.
* Station, position of the Cross-Section, relative to the Stream. The Station is taken as the distance from the current station to the end of the stream. For this purpose, the stream MUST be drawn Downstream to Upstream. THIS IS THE MOST FUNDAMENTAL REQUIREMENT OF THE PROGRAM. If the Stream is drawn in the other direction, then, it must be reversed using the command Reverse Polyline under Edit>Polyline Utilities
* Cut Line: Series of point coordinates, identifying the surface line of the Cross-Section. HEC-RAS identifies the cross-sections as going from left to right as seen from upstream to downstream. The user only needs to make sure that the stream network is drawn in the right direction (downstream to upstream); all other conventions are taken care of by the program.
Modeling Guidelines
Some additional guidelines in drawing the river network in the CAD so as to model correctly for HEC-RAS:

* All the Reaches in the Stream Network must be connected at common End Points; disjointed Stream Networks are not allowed; Reaches must also NOT cross each other.

* Streams cannot contain parallel flow lines. If three reaches connect at a node or End Point, at the most TWO of them can have a common Stream ID. (Please note that a Reach is uniquely identified by a Reach ID and a Stream ID.)

* Cross-Section lines can cross a Reach line only once and cannot cross other X-section lines.

Program Execution
Before starting the "Prepare HEC-RAS Input File" command, all the SCT files and their corresponding MXS files should have been created for every Reach. Points where two streams meet would form a node in the stream network. Sections of a stream between such nodes should be modeled as a Reach. and drawn as a separate polyline. Now, change to the Civil Design Menu. The MXS file for each Reach is created using the command Input Edit Section Alignment under the Sections pulldown menu. Based on any of the methods for creating section files (described in chapter 6 of this manual), the Section file for the Reach is created. The user must manage the .MXS file and the .SCT file corresponding to each Reach. At this point, a Stream ID and Reach ID may be assigned to every Reach, based on a convenient naming convention, which is entirely up to the user. These IDs would be needed when creating the HEC-RAS input file.

The program starts by asking the user for the Header information. The user can input as much information in this dialog box as possible. The "Units" can be "Metric" or "English".

Next, the user will be prompted to enter the .MXS and .SCT file names, the Stream ID and Reach ID for each Reach that you wish to add to your model. The user can enter data (IDs and file names) for as many Reaches as wished. That is, the user can create input files for each Reach individually and import them individually into HEC-RAS or create a combined input file for all the Reaches in the Stream Network. This makes it very convenient to add more Reaches to the HEC-RAS model at a later stage or do the analysis for various sections separately. After entering as many Reaches as needed, the user presses "Exit" to stop entering any further Reaches and to continue with the program execution.

On pressing "Exit", the user is prompted for the Input HEC-RAS file to be created. HEC-RAS input files have a
.GEO extension. When the file is chosen at the prompt, the program creates the input file for HEC-RAS. This file can be used to import geometric data into HEC-RAS, as described below. You must have HEC-RAS version 2.0 or higher installed on your computer.

HEC-RAS

After starting HEC-RAS, select "Geometric Data" from under the "Edit" pulldown menu. This brings up a Geometric data editor, complete with a CAD screen and various options. From the "File" pulldown menu of the Geometric data editor, choose the "Import Geometric Data > GIS Format" command. This brings up a file browser and allows you to choose a geometric data file. Choose the .GEO file just created. This should load the geometric data into HEC-RAS, which is then converted into a CAD format drawing and shows up in the Geometric Data Editor in the form of a Stream network, withEndPoint, Stream ID and Reach IDs, Cross Sections stationing information, along with directions of in each Reach.

At this point, the user can edit several aspects of the data where Carlson only provides default values. Specifically, the Bank Positions and overbank reach lengths can be adjusted here. In addition, the Manning’s coefficient has to be entered for all the cross-sections for all the left, right and center flows. As of HEC-RAS release 2.0, there is no way to input a default value for the Manning’s coefficient, but this situation may improve in future releases of HEC-RAS, in which case the Carlson program will be modified immediately.

Other data that needs to be modified is the location of the left and right banks. By default, the left bank is given to be at 0.45 times the cross-section length and the right bank is given to be at 0.55 times the cross-section length. In order to correctly model the channel geometry, the location of the banks must be accurately defined for each cross-section. This can be done by clicking on the "Cross-Sections" icon in the "Geometric Data Editor" or by clicking with the left mouse on the cross-section to be edited. This brings up all the geometric data related to that particular cross-section, which may be edited as required.
The left and right overbank lengths are defaulted to equal the centerline length (which may not be equal in the case of a sharp bend in the stream). These values can also be edited in the same cross-section editor as mentioned above.

Geometric data can be stored by running "Save Geometric Data" from the "Geometric Data Editor". The file extension assigned for Geometric data files is *.g*, which means that successive geometric data files will be given file extensions in a numeric sequence, beginning with *.g01.

Information specific to each analysis can be entered in the "Steady Flow Data Editor", which can be brought up by selecting "Steady Flow Data" from the Edit pulldown menu of the main HEC-RAS window. The data that can be selected here are the number of profiles that need to be run, flow in each reach for each profile simulation and the Hydraulic boundary conditions at each Reach for each Profile simulation. This information is stored in a file with the extension *.f01 and so on for successive files.

Once all the geometric data and Steady flow data has been entered, the simulation can be run by selecting "Steady Flow Analysis" from the "Simulate" pulldown menu in the main HEC-RAS window. After selecting the type of flow condition (sub-critical, super-critical or mixed), the user selects the "Compute" button to complete the analysis. If there are errors or serious warnings, the program reports them in a text editor. Otherwise, the program shells out to a DOS screen and completes all the necessary calculations. Several options are available for viewing and editing output from the HEC-RAS program, which are best explained in their manual.

Pulldown Menu Location: Watershed->HEC-Ras Water Surface Model
Keyboard Command: sct2ras
Prerequisite: Section data (.sct)

**Draw Hec-Ras Watermark**

This routine takes an SDF output file from HEC-RAS and plots the high-water mark in plan view on the drawing. The procedure is to load the SDF file (.SDF), and if the output file contains more than one reach, you select which reach you wish to plot, from the dialog shown here:
Shown next is an example HEC-RAS watermark plot based on a run of HEC-RAS using the file Hydrolesson.dwg, and using an input flow rate of 20,000 cfs, a Manning's n of 0.013 for the left and right bank conditions, and with the boundary condition set to critical depth:

You will note that the vertices of the drawn polylines for the left and right bank high watermark are exactly at the sections used to create the HEC-RAS input file, using the command Prepare HEC-RAS Input File. The more sections, the smoother the watermark polyline. You need to purchase a copy of HEC-RAS from the Corps of Engineers or other sources in order to use the input file and create the "sdf" output to process in this routine.

**Pulldown Menu Location:** Watershed->HEC-RAS Water Surface Model  
**Keyboard Command:** drawras  
**Prerequisite:** Prepare HEC-RAS Input File, and the program, HEC-RAS or programs that duplicate the output of HEC-RAS

### Import Flow Velocity Points

This function extracts the flow velocity distribution from the HEC-RAS output report file (.REP). The velocity points are extracted at every cross section along the river channel. All points are imported to a Carlson coordinate file (.CRD) and can be plotted in a TIN.

### Running HEC-RAS

In order to get the flow velocity at all cross sections, some guide lines in running HEC-RAS are provided as below.

1. From the Watershed > HEC-RAS Water Surface Model menu in the Hydrology Module, choose Prepare HEC-RAS Input File command to make a HEC-RAS geometry file (.GEO), which contains the cross section data of one or more reaches. Then in HEC-RAS, in Geometric Data dialog, select Import Geometry Data of GIS format from File menu and load the .GEO file.

2. When running Steady/Unsteady Flow Analysis, in the Steady/Unsteady Analysis dialog, choose Flow Distribution Locations command from the Options menu. This command allows you to subdivide the left bank, channel and right bank. Specify as many subsections as needed. You can define up to 45 subsections.
3. After finishing the flow analysis, select Generate Report command from File menu to display the Report Generator dialog. In the Output field, make sure to check the Flow Distribution check box and set the Summary Tables to Standard Table 1.

**Importing Velocity Points**

Select Import Flow Velocity Points from Watershed > HEC-RAS Water Surface Model menu. This command takes the HEC-RAS output file (.REP) and displays the Reaches list and Profiles list in the Import Hydraulic Depth Points dialog. In the Reach Section and Alignment File boxes, type or select a section file (.SCT) and the corresponding section alignment file (.MXS) that have been used to generate HEC-RAS input file (.GEO). In the Import to Flow Velocity CRD File box, type or select a CRD file. In the Starting Point Number box, enter the starting point number, the default number is 1. In the Reach and Profile lists, choose the reach and profile that you want to output, and then
click OK button to extract the flow velocity distributions and write data to the .CRD file.

**Prompts**

**Import Flow Velocity Points dialog**: Fill in values.

**Pulldown Menu Location**: Watershed > HEC - RAS Water Surface Model > Import Flow Velocity Points

**Keyboard Command**: crdrasvt

**Prerequisite**: HEC-RAS output report file (.REP) and the corresponding section file (.SCT) and section alignment file (.MXS)

**Import Flow Depth Points**

This function extracts the flow depth distribution from the HEC-RAS output report file (.REP). The depth points are extracted at every cross section along the river channel. All points are imported to a Carlson coordinate file (.CRD) and can be plotted in a TIN.

**Running HEC-RAS**

In order to get the flow depth at all cross sections, some guidelines in running HEC-RAS are provided as below.

1. From the Watershed > HEC-RAS Water Surface Model menu in the Hydrology Module, choose Prepare HEC-RAS Input File command to make a HEC-RAS geometry file (.GEO), which contains the cross section data of one or more reaches. Then in HEC-RAS, in Geometric Data dialog, select Import Geometry Data of GIS format from File menu and load the .GEO file.

2. When running Steady/Unsteady Flow Analysis, in the Steady/Unsteady Analysis dialog, choose Flow Distribution Locations command from the Options menu. This command allows you to subdivide the left bank, channel and right bank. Specify as many subsections as needed. You can define up to 45 subsections.
3. After finishing the flow analysis, select Generate Report command from File menu to display the Report Generator dialog. In the Output field, make sure to check the Flow Distribution check box and set the Summary Tables to Standard Table 1.

**Importing Depth Points**

Select Import Flow Depth Points from Watershed > HEC-RAS Water Surface Model menu. This command takes the HEC-RAS output file (.REP) and display the Reaches list and Profiles list in the Import Hydraulic Depth Points dialog. In the Reach Section and Alignment File boxes, type or select a section file (.SCT) and the corresponding section alignment file (.MXS) that have been used to generate HEC-RAS input file (.GEO). In the Import to Flow Depth CRD File box, type or select a CRD file. In the Starting Point Number box, enter the starting point number, the default number is 1. In the Reach and Profile lists, choose the reach and profile that you want to output, and then...
click OK button to extract the flow depth distributions and write data to the .CRD file.

Prompts

Import Flow Depth Points dialog: Fill in values.

Pulldown Menu Location: Watershed > HEC - RAS Water Surface Model > Import Flow Depth Points

Keyboard Command: crdrasdt

Prerequisite: HEC-RAS output report file (.REP) and the corresponding section file (.SCT) and section alignment file (.MXS)

HEC2 Programs

The HEC-2 programs include HEC-2, EDIT-2, PLOT-2, and SUMPO. These programs were developed by the Corps of Engineers and their documentation is separate. The programs are distributed with the Hydrology module and are placed in the Carlson EXEC directory. The HEC-2 programs can be placed in another directory and run from Carlson by setting the HEC-2 directory in the Configure command.

Prepare HEC2 Input File

This command is designed to allow the user to create HEC-2 input files. HEC-2 is a computer program prepared by the Corps of Engineers to compute water surface profiles in non-prismatic stream and river channels. The bulk of the input to the HEC-2 program consists of cross-sectional data of the stream and adjacent flood plain. It is in the preparation of this data that Carlson can be of real assistance.

The Prepare HEC-2 Input File routine converts *.sct files prepared in Carlson to HEC-2 input data. The files are given the same name as the *.sct file used to make them and are given the *.h2i file extension. Each line in the HEC-2 text file begins with a two letter identifier, followed by the corresponding data in a fixed format. Each segment of the stream is represented by a group of lines. The header for the section is the "X1" line. On this line is recorded the general information about the section and the channel reach. The "X1" line may be preceded by several change channel lines. "NC" cards are the only representative of the change lines in this routine. This line defines the stream frictional resistance by the Manning's n. The "X1" line is followed by a series of "GR" lines representing the ground at the section. This representation is a list of elevations and distances from a baseline. The baseline is on the left side facing downstream and the distances are positive values, increasing as the section is read from left to right.

Sections are identified in HEC-2 by a 6 character identifier on the "X1" line. The sct2hec conversion program uses the integer value of the centerline station as the identifier for the section. This allows sections at stations up to
9,999+99. This corresponds to study reaches of 189 miles. For the sake of standardization horizontal distances along the section are taken to the even foot and elevations to the 0.1 foot.

The next piece of information on the "X1" line is the number of points on the following "GR" cards. The limit of 100 points in HEC-2 is checked and an alert box generated if applicable. The next two items of data on the "X1" card are the stations of the left and right banks of the stream. In HEC-2 the points must be points on the GR cards. Therefore these entries are made by selecting points from the list of points.

The last data on the "X1" line is the lengths of the channel and overbanks within the reach from the prior section to the current section. The distance between the sections is determined by the difference in stations of the sections on the *.sct file. This distance is presented as the default value for the length of both overbanks and the channel. On the first section these three values are 0, which tells HEC-2 to begin a profile. If the original polyline defining the *.xms file was along the thalweg of the channel then the channel length default is correct. The overbank lengths should be edited for curves in the channel.

A Carlson *.sct file may be made by any one of the seven methods listed on the Sections pull-down of the Civil Design module. A *.sct file made by any of these procedures can be converted to a *.h2i file. The procedure to create an *.sct file from a surface model begins with establishing a polyline as the centerline by which the sections will be oriented and spaced. This should be along or near the thalweg, or center of flow, of the stream and drawn in an upstream direction. From this polyline a *.mxs file is created. The width and location of sections at regular intervals and at special stations are defined in this step. It is this *.mxs file which Carlson uses to define the inundated regions latter in the hydrology modeling. Then the sections are cut and the *.sct file created by the normal means in Carlson. Carlson allows limiting the number of points in the section. Since HEC-2 has a limit of 100 points in a section, that limit should be observed when cutting the sections.

Prompts

When running the convert a *.sct file to a *.h2i file, an input *.sct file is first requested by a file selection dialog box. Then a "Basic Applications for Hec-2" dialog appears requesting information useful for preparing the *.h2i output file. Then a dialog presenting each section as stations appears (shown above). The horizontal distances, called stations in HEC-2, along the cross-section must all be positive numbers increasing across the section. The HEC-2 section represents the ground as a left to right section looking downstream. For the HEC-2 computations the sections are read from the downstream end working upstream. Thus the need to begin the *.mxs file at the downstream end of the stream reach. (The preceding applies to the predominate case of subcritical flow and is reversed for analysis of supercritical flow.)

As each section is read the user is presented with a dialog box to edit data specific to each section. In the right half of the dialog box are edit boxes for the channel and overbank reach lengths. The distance between sections is used as the default in all three boxes. The user may edit these values to correspond to channel curvature or other conditions as hydraulically warranted. If the channel curves left, then the left overbank distance would be smaller and right overbank distance would be larger. There are also input boxes for the Manning's n coefficients for the channel and
overbanks. The Manning's n values may be edited just like any edit box. The top of bank stations are assigned values
by selecting points from the list of all the points in the section displayed along the right of the dialog box. The first
station selected is assumed to be the left bank and the second the right bank. If the user changes his mind about the
bank station, after the first two selections from the list the user can select either right or left bank. These boxes do
not update their display until the user has selected another box to edit. The top of bank stations must correspond to
points on the following "GR" cards, which is why user entry of any number is not allowed. The bank stations are
used by HEC-2 to apply the Manning’s n values assigned by the user.

A complete, but minimal, input file is created by this conversion routine. Certain default values were selected and
written to the output file to make it a complete file. These are:

Begin computations using the slope/area method with 0.01 '/' slope;
Only a single profile will be computed;
On the "T2" card the input *.sct file is recorded;
At each section the default top of bank stations are the first and last points.

The user will normally need to edit the *.h2i file to represent the flows and conditions to model and the type of
output desired. Other parameters which may be added to the input file (a few of which are included in the initial
opening dialog) are:

Contraction and expansion coefficients for energy loss,
Multipliers to Manning’s n,
Call printer plots,
Channel modifications,
Bridges by normal or special methods,
Custom output formats,
Ice conditions and
Encroachments.

All of these items can be entered into the file on the appropriate cards using the DOS Edit program, the Display-Edit
selection in Carlson or a similar editor. The output of the conversion is in the fixed 80 column format expected by
the HEC-2 program. If the user is making significant changes or additions to the data it may be advisable to use the
FREE format option for hand entered data.

The default values for Manning’s n are 0.020 in the channel and 0.030 for both overbanks. These can be edited for
the first section and the edited values will apply to all following sections. Editing the values in latter sections will
create a new "NC" line to be written ahead of that section.

The availability of easy input data to the HEC-2 program will change the way engineers use HEC-2. In the past the
location and number of sections was carefully considered to get the best result with the fewest, most representative,
sections. Now a common topographic survey of the channel reach can provide easily sections at close intervals.
Changes to the stream geometry can be easily modeled in the site plan and converted to HEC-2 data for analysis.
This practically eliminates the need for channel improvement "CI" lines.

Pulldown Menu Location: Watershed
Keyboard Command: sct2hec
Prerequisite: Cross section .sct file

Draw Watermark
This command draws a closed polyline representing the high watermark as calculated by HEC-2. The program uses
the water depth at each station from the HEC-2 output file, the existing section file and a centerline polyline or MXS
file to locate the cross sections. A report is displayed after the watermark polylines are plotted successfully.

Prompts

Select Section File Cross-sections of the surface
Select HEC-2 Output File This is a user-specified file created in HEC-2
Structure Menu

Shown here is the Structure pulldown menu that contains commands for hydraulic structures including ponds, channels, pipes and outlets. The Design Bench Pond and Design Valley Pond commands are described in the Civil Design manual.

Detention Pond Sizing

This command calculates the runoff and storage volumes for a detention pond. The program uses the method from the TR-55 program as described in the Urban Hydrology for Small Watersheds manual.

The command is run through the dialog box shown here. When the input values are filled in, click on the Calculate button to obtain the output values. The drainage area can be either entered directly or selected from AutoCAD by clicking on the Select Area button and then selecting the closed polyline from the screen. The peak inflow will use the value calculated in the Peak Flow-Graphical Method command. Likewise the runoff Q will use the value from the Curve Numbers & Runoff routine.

The output of this command, the storage volume value, can be applied to the Design Bench, Valley or Rectangular Pond routines. There is also an option to generate a TR-55 6A report.
Prompts

**Detention Pond Parameters dialog:** Fill in values

**Pulldown Menu Location:** Structure > Detention Pond Sizing > TR-55 Method

**Keyboard Command:** dpond

**Prerequisite:** None

---

**Detention Pond Sizing - Linear Storage Estimate Method**

This command calculates storage volumes for a detention pond by Linear Storage method. This method uses an inflow hydrograph and asks you to specify the peak outflow discharge from the reservoir. The program draws a straight line from the zero flow point on the hydrograph to the intersection of the specified outflow and the inflow hydrograph curve. The volume between this line and the hydrograph curve is then computed to be the storage required for the pond.

The output of this command can be applied to the Design Bench, Valley or Rectangular Pond routines. There is also an option to generate a report.
Rectangular Pond Design

This program will draw rectangular ponds and calculate storage at any level in the pond corresponding to top of pond, emergency spillway, principal spillway and sediment (cleanout) level. Elevations can be "reverse-calculated" based on requested storage amounts. All calculations derive from input length-width and slope ratio values. Only one common ratio is used for the interior pond slopes (e.g. 1:1 or 2:1, etc.).

The Draw Details button will output scaled and fully annotated plan view, section A-A and section B-B drawings, complete with principal and emergency spillways. For simplicity, the principal spillway is considered to be a pipe spillway, and the emergency spillway is considered to be a flat-bottom weir spillway. If the pond in question has only one spillway, then the appropriate spillway elevation is entered in the dialog box, and the other spillway option is left blank.

The Stage-Storage File button will produce a table of storage values as .CAP file which can be plotted using the file option within the Draw Stage-Storage routine and used in hydrograph routing routines. The Report function creates a report that is shown in the standard report viewer and includes pond dimensions, storage volumes and "Required Freeboard". The Draw Surface function will draw the pond into the drawing using the Design Bench Pond command. The program will prompt for the target surface model for the pond outslopes to tie into, the location and rotation for the rectangular pond, the top of dam width and the outslope slope ratios. The net effect of the Rectangular Pond Design routine is that you can calculate necessary pond storages, plot the pond detail drawings, write out and import the report summary and plot the pond stage-storage curve.

There are ways to use the routine in "shortcut" form to draw ponds. Simply by completing 3 dialog entries (base width, base length and total depth) the user can draw the plan view, section A-A and section B-B. This is why the Pond Elevation items are considered "optional". The programs can also be used as a pond storage calculator. Any of
the Pond Elevation options (excepting peak stage), when completed will lead to recalculated storage values. Storage values can likewise be altered and will lead to recalculated elevations. The act of pressing enter inside a dialog box activates the calculation process. If there is no need to plot the pond detail drawings, the cancel "button" in the dialog can be selected following calculations.

Prompts

The program begins by presenting the dialog. One effective way to fill out the dialog boxes is to pick the upper left box and work down and through the options by pressing the tab key after each entry. If all items are filled out as shown, the following prompts will appear:

Enter Scale Factor for Pond Drawing(s) <1>: press Enter
Draw Plan View? (<y>/n): press Enter Pick Lower Left Corner: Plot Cleanout and Spillway Lines (<y>/n): press Enter
Pick Location of Principal Spillway:
Draw Section A-A Horizontal (<y>/n): y
Pick Left Location of Section A-A:
Pick Right Location of Section A-A:
Draw Section B-B Vertical (<y>/n): y
Pick One Side of Section B-B:
Pick other Side of Section B-B:
Pick Upper Left Corner for Section A-A:
Plot Cleanout and Spillway Lines (<y>/n): press Enter
Pick Upper Left Corner for Section B-B:
Plot Cleanout and Spillway Lines (<y>/n): press Enter

If no Section A-A or Section B-B identifier lines are drawn, no section A-A or Section B-B details will be drawn. Thus if you want Section A-A only, say "y" to Draw Section A-A Horizontal but "n" or Enter to Draw Section B-B Vertical. If you entered only length, width and depth in the original dialog, the resultant prompting would be:

Enter Scale Factor for Pond Drawing(s) <1>: press Enter
Draw Plan View? (<y>/n): press Enter
Pick Lower Left Corner:
Draw Section A-A Horizontal (<y>/n): y
Pick Left Location of Section A-A:
Pick Right Location of Section A-A:
Draw Section B-B Vertical (<y>/n): y
Pick One Side of Section B-B:
Pick Other End of Section B-B:
Pick Upper Left Corner of Section A-A:
Pick Upper Left Corner of Section B-B:
Plots produced by the entries in the preceding dialog

Keep in mind that the scale factor, if other than 1, will enlarge or reduce the size of the detail drawings to suit the users needs, yet will annotate dimensions correctly in all cases.

The imported text based on the output ASCII file POND.TXT (located in \SCADXML\WORK by default) would appear as follows:

**Top of Pond Elevation:** 1070.00 feet  
**Peak Stage (25th year-24 hour Storm Event):** 1069.45 feet  
**Includes 1.00 feet of Freeboard**  
**Emergency Spillway Elevation:** 1067.00 feet  
**Emergency Spillway Bottom Width:** 10.00 feet  
**Principal Spillway Invert Elevation:** 1065.50 feet  
**Principal Spillway Diameter:** 42.00 in.  
**Principal Spillway Slope:** 2.00 %  
**Sediment Pool (Cleanout) Elevation:** 1064.00 feet  
**Bottom of Pond Elevation:** 1060.00 feet  
**Storage Volume at Emergency Spillway:** 0.2990 ac.ft.  
**Storage Volume at Principal Spillway:** 0.2150 ac.ft.  
**Storage Volume at Sediment Pool:** 0.1430 ac.ft.

The routines are fully metric and will substitute meters and cubic meters appropriately for feet and acre-feet. Pipe sizes, however, will default to diameters in inches.

**Pulldown Menu Location:** Structure in Hydrology  
**Keyboard Command:** rpond  
**Prerequisite:** None

---

## Design Spillway

This command creates a spillway with 3D polylines in the drawing. The program uses a surface model of the area for the spillway, a spillway centerline and spillway dimensions (width, elevation, etc.). The surface model of the area can be defined by contour polylines, points and 3D polylines or can be created by the Design Bench or Valley Pond commands. The spillway dimensions can be calculated by the Design Channel commands to meet the desired discharge. The amount of cut required to make the spillway is calculated and reported.
Prompts

Source of surface model (File/Screen)? press Enter Use the File option to select a .grd file.
Pick Lower Left limit of surface area: pick lower left
Pick Upper Right limit of surface area: pick upper right Be sure to pick these limits well beyond the area of the spillway centerline in order to make room for the outslopes.

Make GRiD File Dialog
After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.
Pick the spillway centerline: select polyline that crosses the dam
Pick a point within the pond: pick a point The program needs to know which end of the spillway centerline is within the pond.

Enter slopes as percent grade or slope ratio (Percent/Ratio)? press Enter
Enter the side slope ratio <1.0>: press Enter
Enter the flow slope ratio <100.0>: press Enter
Range of existing elevations along spillway centerline.
Enter spillway elevation <1476.5>: 1475.0 This is the entrance elevation of the spillway
Enter the spillway width <10.0>: press Enter

Spillway Report:
Spillway inlet elevation: 1445.0000
Spillway outlet elevation: 1445.0000
Spillway width: 10.0000
Side slope percent grade: 100.00, slope ratio: 1.00
Flow slope percent grade: 1.00, slope ratio: 100.00
Spillway EarthWork Volumes
Total cut: 55.593 C.Y., 1501.00150 C.F.

Spillway added to valley pond

Pulldown Menu Location: Structure in Hydrology
Keyboard Command: spill
Prerequisite: Surface entities that model the pond

Drop Pipe Spillway Design
This program calculates the spillway discharge at different water elevations. As the water elevation initially rises above the riser, the flow is controlled by weir flow. The program uses the perimeter of the riser for the weir length for the weir flow calculation. The riser can be either circular or box. At higher water elevations the flow is under
orifice control. When the barrel flows full, the flow is controlled by full pipe flow. Given the water elevation and spillway dimensions, the program calculates the type of flow and discharge.

The Calculate button will read the values in the dialog, calculate the flow and report this flow value at the bottom of the dialog. The Report button will generate a report of the input values and calculated flows. The File routine will create a stage-discharge (.STG) file. The Draw function will draw and label the drop pipe spillway in the drawing at the specified scale. The Graph button creates a stage-discharge graph.

**Riser Parameters**: Indicate the various parameters for the vertical riser pipe.

**Culvert Parameters**: Indicate the various parameters associated with the culvert.

**Headwater Elev**: Indicate the water (pool) elevation.

**Calc**: Causes the routine to read the values in the dialog and calculate the Discharge flow which is subsequently reported.

**Stage-Discharge Result**: Displays the following dialog box that allows you to indicate the water elevation range and increment to report:
Write Stage-Discharge File: Creates a Stage-Discharge (.STG) file that can be used in other Carlson Hydrology commands.

Draw: Allows a graphic representation of the Stage-Discharge data to be placed into the drawing.

Draw Grid: When enabled, this option creates a grid that accompanies the Stage-Discharge curve. Click the Setup button to access the grid settings which are discussed in detail in the Draw Grid section of the Draw Profile command.

Output to Separate Drawing: When enabled, this option draws the hydrograph to a separate drawing. Click the Set button to specify the name/location of the external drawing.

Horizontal Scale: Specify the discharge scale (in CFS).

Vertical Scale: Specify the stage scale (in Ft).

The Layers, Colors, Text Styles/Sizes and Linetypes buttons provide access to settings for each of these features of the Stage-Discharge curve.

Load Settings: Loads a saved collection of Draw Stage-Discharge settings, saved in a (.PFS) file.

Save Settings: Saves all Draw Stage-Discharge settings in a (.PFS) file.

Pulldown Menu Location(s): Structure

Keyboard Command: spillway

Prerequisite: None

Rectangular Weir Design

This program calculates the dimensions of a rectangular weir given the outflow discharge. The default discharge uses the value from the Detention Pond command. The weir width and depth are two free variables. Enter a value
for one and press Enter. Then the value for the other is calculated.

The weir design may optionally be applied to a pond design. First enter a Required Storage Volume which can come from the Detention Pond command. Then click Apply to Actual Pond and choose a Storage Capacity File (.CAP). This .cap file can be created by Bench or Valley Pond Design and by the Stage-Storage command. The program then computes the elevation at the required storage volume and the corresponding elevation for the bottom of the weir given the weir depth.

When the Draw Spillway Detail option is checked, a drawing of the weir is created as shown below.

![Pond Weir Spillway Design](image)

**Pulldown Menu Location:** Structure in Hydrology  
**Keyboard Command:** weir  
**Prerequisite:** None

### Advanced Weir Design
The Advanced Weir Design uses the methodology described in HEC-22 Manual. The weir flow is determined as:

\[
Q = C_w \cdot L \cdot H^{0.5}
\]

for the Rectangular Weir without Contracted End

\[
Q = C_w \cdot (L - 0.2 \cdot H)^{0.5}
\]

for the Rectangular Weir with Contracted End

where:  
- \( Q \) = discharge, \( \text{ft}^3/\text{s} \) (\( \text{m}^3/\text{s} \))  
- \( C_w \) = weir coefficient, 3.33 in English units (1.84 in Metric units)  
- \( L \) = weir length, \( \text{ft} \) (\( \text{m} \))  
- \( H \) = head above weir crest, \( \text{ft} \) (\( \text{m} \))

\[
Q = C_w \cdot [\tan(\pi/2) H^{2.5} + 5/4 L H^{1.5}]
\]

for Trapezoidal Weir
where: $Q =$ discharge, $\text{ft}^3/\text{s}$ ($\text{m}^3/\text{s}$)

$C_w =$ weir coefficient, 3.33 in English units (1.84 in Metric units)

$L =$ weir length, ft (m)

$\theta =$ internal angle of the two sides, degrees

$H =$ head above weir crest, ft (m)

$$Q = C_w \tan(\theta/2) H^{2.5}$$ for V-Notched Weir

where: $Q =$ discharge, $\text{ft}^3/\text{s}$ ($\text{m}^3/\text{s}$)

$C_w =$ weir coefficient, 2.5 in English units (1.38 in Metric units)

$\theta =$ angle of v-notch, degrees

$H =$ head above weir crest, ft (m)

This command designs a weir structure and calculates its stage-discharge curve. Select Weir Design from the Structure menu in the Hydrology Module to display the design dialog. Select the Type of the weir, Rectangular, Trapezoidal or V-notched. Enter the dimension for the weir. In the Invert Elev box, type the absolute elevation at which the weir will be attached to a reservoir. The attachment point is at the bottom of the weir. In the Coefficient box, type a weir coefficient value. In the Number of Openings box, enter the number of weirs you want to combine.

In the Headwater box, type the absolute headwater surface elevation. Click on the Calculate button, the maximum discharge and flow velocity through the weir would be computed and displayed.

Click on the Stage-Discharge Result button to display the stage-discharge curve in the Stage-Discharge Result Dialog. This dialog allows you to write the stage-discharge data to a stage-discharge file (.STG), and draw the stage-discharge curve on the screen. From the Stage-Discharge Curve Draw Settings dialog, you can specify how to draw the curve. The Report button generates the weir design report.
The Orifice Design uses the methodology described in HEC-22 Manual. The orifice flow is determined as:

\[ Q = C_o A_o (2 g H_o)^{0.5} \]

where: \( Q = \) discharge, \( \text{ft}^3/\text{s} \) (\( \text{m}^3/\text{s} \))
\( C_o = \) orifice coefficient, unitless (0.40 - 0.60)
\( A_o = \) area of orifice, \( \text{ft}^2 \) (\( \text{m}^2 \))
\( H_o = \) effective head on the orifice measured from the centroid of the opening, \( \text{ft} \) (\( \text{m} \))
\( g = \) gravitational acceleration, 32.2 \( \text{ft}/\text{s}^2 \) (9.81 \( \text{m}/\text{s}^2 \))

This command designs an orifice structure and calculates its stage-discharge curve. Select Orifice Design from the Structure menu in the Hydrology Module to display the design dialog. Select the Section Type of the orifice, Circular or Rectangular. Enter the dimension for the orifice. In the Invert Elev box, type the absolute elevation at which the orifice will be attached to a reservoir. The attachment point is at the bottom of the orifice. In the Coefficient box, type a roughness coefficient for the orifice. The coefficient ranges from 0.4 to 0.6 (HEC-22). In the Number of Openings box, enter the number of orifices you want to combine.

In the Headwater and Tailwater boxes, type the absolute headwater surface elevation and tailwater surface elevation respectively. Click on the Calculate button, the maximum discharge and flow velocity through the orifice would be computed and displayed.

Click on the Stage-Discharge Result button to display the stage-discharge curve in the Stage-Discharge Result Dialog. This dialog allows you to write the stage-discharge data to a stage-discharge file(.STG), and draw the stage-discharge curve on the screen. From the Stage-Discharge Curve Draw Settings dialog , you can specify how to draw the curve. The Report button generates the orifice design report.
### Pond Exfiltration Design

Exfiltration is classified as an outlet device and is incorporated into a pond's stage-discharge curve. But exfiltration is usually directed to the discarded outflow to prevent further routing. There are two design methods to determine exfiltration, shown below:

1. **Constant Exfiltration Flow**: The flow value (cfs or cms) is applied whenever there is water in the pond, or only when the water level is at or above the specified invert elevation.

2. **Exfiltration Velocity**: The velocity (in/hr or mm/hr) is multiplied by the exfiltration area at a given elevation to determine the final exfiltration flow.

The exfiltration area may be defined in three ways: 1) Pond Bottom Area, which allows the exfiltration only through the bottom of pond; 2) Water Surface Area, which assumes the exfiltration is downward; 3) Pond Wetted Area, which allows the exfiltration occur through all exposed surfaces regardless of slope. You may also choose to exclude the area of the pond that lies at or below the specified invert elevation, which is useful in preventing exfiltration through impervious (lower) regions of the pond.

There are two ways to enter the pond parameters. If you elect to input the stage-storage curve, the program will determine the bottom and side areas automatically.
Chapter 7. Hydrology Module
Pulldown Menu Location: Structure > Pond Exfiltration Design
Keyboard Command: exfilcalc
Prerequisite: None

Multiple Outlet Design
Multiple Outlet Design attaches multiple outlet structures to a detention pond and computes the stage-discharge data. All design parameters are stored in a combo outlet file (.COT). This command allows you to add, edit and remove outlet structures attached to a pond, and you can see how different combinations of structures affect the stage-discharge calculation. There are six types of outlet structures: culvert, drop pipe, orifice, weir, exfiltration and user defined stage-discharge curve. Please refer to the documentation of Culvert Design, Drop Pipe Spillway Design, Orifice Design, Weir Design and Input-Edit Stage-Discharge for the details.

From the Structure menu in the Hydrology Module, choose Multiple Outlet Design command to open the design dialog. You need to specify an existing or a new combo outlet file (.COT) to load it into the design dialog. The dialog has a spreadsheet with a list of all the outlets. You can edit the Outlet Name, Invert Elevation and Outlet Type right in the spreadsheet. Or use the Edit button to bring up a dialog editor for the current highlighted outlet. The Used In Design toggle allows you to turn on and off whether to include the outlet in the discharge calculations.

Click on Add button to display the New Outlet Structure dialog. Enter the structure name and select a structure type, then click the OK button to display the outlet design dialog for that structure. Configure the structure in the design dialog and then click OK to exit the dialog and come back to the main dialog, which highlights the new structure and indicates its parameters and the stage-discharge result.

The Edit and Remove buttons allow you to edit and remove the highlighted outlet. The Stage-Discharge Result
button computes the discharges at each stage from the minimum water elevation to the maximum, and displays the result in the Stage-Discharge Result Dialog. The Report button reports the design parameters and the discharge results in the standard Carlson report display window, from where the information can be edited, saved, and printed to a printer or to the screen. The Load button allows you to load other combo outlet files (.COT) for editing. The Save and SaveAs buttons save the current design parameters to a outlet file.

The Check Discharge section allows you to enter a Water Elevation and Tailwater Elevation and the program reports the total discharge from all the outlets along with the discharge for the currently highlighted outlet.
Stage-Discharge Result Dialog

Pulldown Menu Location: Structure > Multiple Outlet Design
Keyboard Command: poutlet
Prerequisite: None

Input-Edit Stage-Storage

This command allows you to define a reservoir by entering stage/storage data in four ways: stage/storage or stage/area data, stage/contour area data, rectangular/trapezoidal pond definition and underground pipe definition.

From the Structure > Stage-Storage menu in the Hydrology Module, choose Input-Edit Stage-Storage to open the design dialog. Enter the pond name in the Structure Name box. There are four Storage Methods: User Defined Storage allows you to manually enter stage-storage or stage-area data, Irregular Shape allows you to select the contours of a surface model from a drawing, Rectangular Shape is used to define a rectangular or trapezoidal pond and Underground Pipe is used to define pipe shape reservoirs. Stage-Storage Data section displays the stage-storage curve data. Click on the Edit Detention Structure button to create/edit the stage-storage input. The Check Storage fields are a tool for entering the elevation or stage and reporting the storage and area at that level. Load, Save and SaveAs buttons allow you to load and save the stage-storage data. The Report button generates the stage-storage report as bellow. For a customized report or other output formats, turn on the Use Report Formatter option and then pick Report.
In the spreadsheet, you can enter elevations and corresponding cumulative volumes, or elevations and the corresponding areas. Before entering data, set the Storage Unit to Cumulative Volume or Area, depending on what type of data you have. The area data represents the areas at the specified elevation while the volume correlates to the volume between the first elevation and the current elevation. The first entry always contains the lowest elevation in your reservoir, the cumulative volume should be 0.0, or the area should be the area of the reservoir bottom if the Storage Unit is area. All the elevation entries are in the increasing order. In the Base Area box, enter the area at the lowest elevation. Insert and Delete buttons allow you to insert and delete a row at the cursor. Click on OK button to save the stage-storage data.

User Defined Storage

In the spreadsheet, you can enter elevations and corresponding cumulative volumes, or elevations and the corresponding areas. Before entering data, set the Storage Unit to Cumulative Volume or Area, depending on what type of data you have. The area data represents the areas at the specified elevation while the volume correlates to the volume between the first elevation and the current elevation. The first entry always contains the lowest elevation in your reservoir, the cumulative volume should be 0.0, or the area should be the area of the reservoir bottom if the Storage Unit is area. All the elevation entries are in the increasing order. In the Base Area box, enter the area at the lowest elevation. Insert and Delete buttons allow you to insert and delete a row at the cursor. Click on OK button to save the stage-storage data.
Irregular Shape

This method allows you to define an irregular shape pond from the contour polylines of a surface model, and generate the stage-storage data automatically. In order to use this method, you must have the surface drawing open, which contains the contours that you want to use to define the reservoir. Click on the Select Pond Contours and select as many contours as you need, the stage/storage and stage/area relationship will be then determined and displayed in the Stage-Storage Data table, starting from the lowest elevation to the maximum. Click on OK button to save the data.

Rectangular Shape

This method allows you to define a rectangular box or trapezoidal shape reservoir. Enter values in the Top Elevation, Base Elevation, Base Length and Base Width boxes. If you want to define a trapezoidal shape reservoir, enter the Length Slope Ratio and Width Slope Ratio. You also need to specify the Stage Increment. Click on OK button to save pond parameters.
Underground Pipe

This method allows you to specify a reservoir as a pipe. Pipes come in circular and rectangular shapes. Enter the pipe dimensions and the Invert Elev at which the pipe is located. Specify the Number of Barrels and the Stage Increment. Click on OK button to save the pipe parameters.

Stage-Storage Curve

When you click on the Graph button, the Stage-Storage Curve dialog displays. A image is shown for you to view the stage vs. storage, stage vs area plot for the reservoir. The graph can be plotted into the CAD graphic by clicking on Draw button. When you click on the Draw button, the Stage-Storage Curve Settings dialog displays from where you can define how to plot the text and graph on screen.
Stage-Storage Curve

Pulldown Menu Location: Structure > Stage-Storage > Input-Edit Stage-Storage

Keyboard Command: edit_stage_store

Prerequisite: a stage-storage file (.CAP)

Calculate Stage-Storage

This command calculates stage-storage values for a pond that is already drawn in the drawing. Before running this routine, the surface model for the pond must be created as a triangulation file with Triangulate & Contour or as a grid file with Make 3D Grid File. A closed polyline for the perimeter of the pond is also required. It has the option to save a stage-storage capacity file, in one of 2 forms (Carlson for readability, or Sedcad form, for importing into Sedcad). The type of file stored is set in Configure, Hydrology Module.
Prompts

Select Pond Surface
Select the .tin, .flt or .grd file that models the pond surface.

Pick the top of dam polyline: pick the closed polyline perimeter

Choose method to specify storage elevations (<Automatic>/Interval/Manual)? Manual

Range of pond elevations: 1202 to 1220

Sediment Elevation (Enter for none): 1206
Enter stage elevation (Enter for none): 1206
Enter stage elevation (Enter for none): 1210
Enter stage elevation (Enter for none): 1215
Enter stage elevation (Enter for none): 1220
Enter stage elevation (Enter for none): press Enter

Pond Storage Volumes Report

<table>
<thead>
<tr>
<th>Water Elev</th>
<th>Storage (Acre Ft)</th>
<th>(C.Y.)</th>
<th>(C.F.)</th>
<th>Area (Acre)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1206.00</td>
<td>0.00000</td>
<td>0.0</td>
<td>0.0</td>
<td>0.141</td>
</tr>
<tr>
<td>1210.00</td>
<td>0.67919</td>
<td>1,093</td>
<td>29585.4</td>
<td>0.208</td>
</tr>
<tr>
<td>1215.00</td>
<td>1.96486</td>
<td>3,170</td>
<td>85589.4</td>
<td>0.322</td>
</tr>
<tr>
<td>1220.00</td>
<td>3.92578</td>
<td>6,333</td>
<td>171007.1</td>
<td>0.476</td>
</tr>
</tbody>
</table>

Write stage-storage to file [Yes/No]? press Enter

When saving a stage-storage capacity file, to be drawn in the Draw Stage-Storage Curve command, it is a good idea to limit the number of stages to a reasonable number, such as 6 to 12 stages. More than 12 will plot off the page in a long list, unless you use the option "Skip Every 2nd Table Entry". If the stages are at odd intervals, the Draw Stage-Storage Curve command will interpolate additional stages, so reducing the number of stages used works best for plotting.

Typical Pond for Calculate Stage Storage

Pulldown Menu Location: Structure in Hydrology
Keyboard Command: postpond
Prerequisite: Surface entities that model the pond
Draw Stage-Storage Curve

This routine draws a pond stage storage curve with pond elevation on the vertical axis and acre-feet of storage on the horizontal axis. It will plot and label the emergency spillway, principal spillway and cleanout levels and will produce a table of storage data. The program will read and write a .CAP file of pond storage, based on areas at each stage or elevation. CAP files (short for "capacity") are made by Bench Pond Design, Valley Pond Design, Rectangular Pond Design, Calculate Stage Storage and by the Stage Storage Curve program itself. These programs output two types of CAP files, one which is read by SEDCAD, a popular hydrology and sedimentology program, and another which is a simple comma-delimited file for easy viewing in spreadsheets or text editors.

In addition to file-based inputs, the user can enter pond dimensions directly by length-width, area at each stage, or volume at each stage. The above drawing was created by the entry of widths and lengths at increasing elevation, entered within the routine itself. Also shown at the bottom is the default certification, obtained by clicking on the certification option. All text is editable. If stage-storage curves are loaded from file, which contains only volumes at different stages, then the width and length columns are filled in as "N/A" (not applicable). Since volume-based entry does not include area information, no CAP files are stored with this option. However, the curves plot in all cases. Plots are sized to fit on 8.5 x 11 sheets at the selected scale for plotting. They are particularly suited for permit applications, so the program will prompt for permit number and page.

Prompts

The program is dialog-driven. The first dialog controls file loading and some pre-calculation options, and is shown below:
In this case we have loaded a stage-storage curve from a stored capacity file. The program will automatically display the top of structure. If your goal is to set the emergency spillway at an elevation with storage 5.5 acre-feet, you can enter the storage in the lower left and calculate the appropriate elevation. You can also compute permanent pool elevations by entering runoff quantities. A total runoff of 3.5 acre feet, subtracted from the acre-feet at the principal spillway, will set the recommended elevation of the "clean out level". If the pond silted up above that level, then the silt needs to be removed. In Kentucky, for example, the minimum vertical separation between principal spillway and clean out level is 1.5 feet.

If you choose to manually enter the pond area, dimensions or volume at increasing stages (elevations), then all the options in the lower portion of the Dialog "ghost" and are not available, since the pond characteristics are not yet known. Then prompting appears as shown below:

**Input (A)rea, Length/Width (D)imensions or <V>olume: D**

**Stage No. 1**
**Elevation:** 940
**Width:** 20
**Length:** 60
<<Enter>> for more, (R) to Revise, (E) to exit entry: If you made a mistake, you could enter R and then enter a revised Elevation, Width and Length. Otherwise, press Enter to continue.

**Stage No. 2**
**Elevation:** 945
**Width:** 30
**Length:** 70
<<Enter>> for more, (R) to Revise, (E) to exit entry: press Enter

**Stage No. 3**
**Elevation <950.00>:** The program defaults to the last interval.
**Width:** 40
**Length:** 80
<<Enter>> for more, (R) to Revise, (E) to exit entry: E to exit
A table appears, similar to the following:

<table>
<thead>
<tr>
<th>Elev (Ft)</th>
<th>Width (Ft)</th>
<th>Length (Ft)</th>
<th>Area (Acre)</th>
<th>Interval (Ft)</th>
<th>Avg. Area (Acre)</th>
<th>Inc. Vol (Acre Ft)</th>
<th>Acc. Vol (Acre Ft)</th>
<th>Stage</th>
</tr>
</thead>
<tbody>
<tr>
<td>940</td>
<td>20.0</td>
<td>60.0</td>
<td>0.028</td>
<td>0.00</td>
<td>0.028</td>
<td>0.000</td>
<td>0.000</td>
<td>0.00</td>
</tr>
<tr>
<td>945</td>
<td>30.0</td>
<td>70.0</td>
<td>0.048</td>
<td>5.00</td>
<td>0.038</td>
<td>0.189</td>
<td>0.189</td>
<td>5.00</td>
</tr>
<tr>
<td>950</td>
<td>40.0</td>
<td>80.0</td>
<td>0.073</td>
<td>5.00</td>
<td>0.061</td>
<td>0.304</td>
<td>0.494</td>
<td>10.00</td>
</tr>
</tbody>
</table>

Areas are in acres. If the area method of entry were chosen instead, the user would have been prompted for area at each elevation (stage), and the summary table would be blank under the width and length columns. Similarly, if entry was by volume (in cubic feet), all width, length and area columns would be blank.

**Calculate Storage or Elevation Points (y/<n>):**

- **Known (E)levation or known <S>torage:**
- **Storage (e.g. 0.2 or %60 for 60% of total): %60**
- **Storage: 0.30 Elevation: 946.759**

**Calculate Storage or Elevation Points (y/<n>): press Enter** This allows you to move on. The advantage of this option is the ability to find exact spillway and cleanout levels by experimenting with needed storages or desired elevations. For example, sediment cleanout levels are often set at 60% of total storage, which would be in this case 946.76.

- **Elevation of Top of Structure:** 950
- **Elevation of Emergency Spillway:** 948.5
- **Elevation of Principal Spillway (Enter if same): press Enter**
- **Elevation of Cleanout Level:** 946.76

**Is Above Data OK (<y>/n): press Enter** n leads to re-entry of above 4 items

Regardless of whether the stage-storage information was hand-entered or loaded from a capacity file, you are in all cases led to the next dialog, which governs the drawing and labeling of the stage-storage curve graph and text:

Note that it is often beneficial to "skip every 2nd table entry", since the table of text for each stage may exceed the space allotted to it. You can also plot a "Stage-Area Curve" as well as a Stage-Storage Curve, with the Stage-Area horizontal access scale information plotted on the top of the graph.
A business address or typed-in certification can be entered here as well.

Pick Starting Position: pick lower left corner of stage storage curve on screen
Company Name: Maysville Survey & Engineering
Address Line 1: 105 W. 2nd Street
Address Line 2: Maysville, KY 41056

Store Pond Capacity File (y/<n>): y This prompt appears if you hand-enter stage-storage information without the routine and is followed by the normal store file dialog.

Note that if Drawing Setup is set to metric, the stage-storage curve is calculated in cubic meters and all entries are in meters. The final result of a typical combined Stage-Storage and Stage-Area plot is shown below:

---

**Input-Edit Stage-Discharge**

This command allows you to manually input and edit the discharge data at specific elevations. A rating curve is created between the minimum and maximum elevations. Insert Row and Delete Row buttons insert and delete rows at the cursor. Load, Save and SaveAs buttons allow you to load and save the stage-discharge data. Click on the Graph button to open the Stage-Discharge Curve dialog to view the stage-discharge data. After viewing the data, you can plot the graph into the CAD graphic by clicking on Draw button. When you click on the Draw button, the Stage-Discharge Curve Settings dialog displays from where you can define how to plot the text and graph on screen.
Input>Edit Stage-Discharge Curve

Stage-Discharge Curve
Stage-Discharge Curve Draw Settings

PullDown Menu Location: Structure > Stage-Discharge > Input-Edit Stage-Discharge
Keyboard Command: edit_stage_discharge
Prerequisite: a stage-discharge file (.STG)

Draw Stage-Discharge Graph

This program draws a stage-discharge graph with the stage (water elevation) on the Y-axis and the discharge on the X-axis. The data to graph is read from a stage-discharge (.stg) file which can be created by several routines including Design Channel, Drop Spillway, etc.

First you are prompted to select a STG file to draw. Then the program asks for the ending discharge for the graph which defaults to the highest discharge in the file. Next this dialog is displayed to enter the graph scale and intervals. The height of the annotation equals the horizontal scale times the Axis Text Scaler.
Report Stage-Discharge

This command simply loads and presents a stage-discharge file, for review and printing. The Report Formatter is used for selecting which fields to report and field properties. Also, the Report Formatter has output to different formats such as Excel. The procedure is to load the file from the normal file loading dialog, then review, edit or print it as shown below:

Pulldown Menu Location: Structure in Hydrology
Keyboard Command: stg_report
Prerequisite: Creation of Stage-Discharge File in Pipe, Channel and Spillway Design routines

Merge Stage-Discharge Files

This command combines two or more stage-discharge files into a single, merged file. Ponds with two or more spillways (for example, a principal and emergency spillway) will outflow increasing volumes of water at higher elevations (stages) in the pond. In many ponds, a principal spillway allows baseline, non-storm flow to exit the pond, and an emergency spillway, placed at a higher elevation, permits storm flows to exit the pond as the water in the pond rises. Because flows increase for virtually all spillway types with increasing water elevation above the spillway, stage-discharge files (.STG files) will show increasing flow at increasing elevation. For ponds with more
than one spillway, it is necessary to combine or merge the flows from the multiple spillways as they are encountered at higher elevation. The most typical application is to merge the flow from the principal and emergency spillways that are used on most pond designs. (See graphic in Draw Stage-Storage Curve.) These merged stage-discharge files are then used in the command Locate Structures, found under the Watershed pulldown menu. This command will also merge multiple selections of single stage-discharge files, or will accept a "pre-merged" stage-discharge file. In combination with the pond stage-storage files, the structures in a watershed layout will be used to compute hydrographs and determine the impact of pond placement and spillway design on reducing storm flows.

Prompts

The command is dialog-driven, in this order:

First Stage-Discharge File to Merge. (It is recommended to load the lowest elevation spillway file, typically the principal spillway stage-discharge file.)

Next Stage-Discharge File to Merge. (Here you would typically load the emergency spillway stage-discharge file.)

Merge Another Stage-Discharge File? Yes/No. Click Yes if there is another stage-discharge file, otherwise click No.

Choose the Output Stage-Discharge File. Name the output stage-discharge file.

Pulldown Menu Location: Structure in Hydrology

Keyboard Command: merge stg

Prerequisite: Spillway design routines that create Stage-Discharge Files, such as Drop Pipe Spillway Design, Pond Weir Spillway Design, Open Channel (Manning's Eq) and Pipe Culvert Design.

Channel Design - NonErodible Mannings Equation

This will compute channel depth, flow and velocity based on channel parameters such as side slopes, base dimensions and Manning's n value. It handles triangular, trapezoidal, rectangular and irregular channels. Entry of a depth leads to calculation of flow and velocity. Entry of one of the other items (flow or velocity) will lead to calculation of the remaining items. In addition to functioning as a channel calculator, the program will output a typical section or detail of the channel as well as a report of the channel output. The routine also works in metric units. It applies to non-erodible channels, primarily. The user can select the Report button to output a report of the channel input and output values as well as a standard detail shown below for the above example.

Prompts

When the routine is selected, the dialog box shown below appears. Select, for example, a trapezoidal channel, equal sides, with side slopes of 3 (for 3:1) and a base dimension of 16. Enter the Manning's n value and channel slope as shown. Note that 0.1, in English units, means 0.1 foot drop per 100 foot of length. Then at the lower right, plug a value of 4.5 for the depth. This will calculate a flow of 862 CFS and a velocity of 6.5 fps, as shown below. If the channel is divided into two types of materials (paved lower portions and vegetated upper portion), you can specify a second Manning's n for the upper banks, as shown in the dialog.
To use the routine as a calculator, enter the known value in the lower right area of the dialog (flow, depth, or velocity), then press enter while still in the entered item. The other two items are then calculated. Note that the routine will default to the last values used during the current Carlson work session, and will capture the flow values calculated in Water Runoff under the Watershed Pull-down. When entering the Manning’s n value, a table of n values can be brought up and an appropriate Manning’s selected. Among the output options is “Draw Channel Detail”, which will draw and annotate as shown below. Since Open Channels are often used as emergency spillways, the Write Stage/Discharge File will output an .STG file for use in the command Locate Structure under Watershed, for pond design and storm routing and hydrograph calculations.

Use Drawing Setup to activate Metric or English outputs. If English is configured, the formula \( v = \frac{(1.486/n)(R^{2/3})(s^{1/2})}{R^{2/3}} \) is used, where \( n \) is the Manning’s value, \( R \) is the water cross section divided by the wetted perimeter and \( s \) is the slope ratio. If Metric is configured, the formula becomes \( v = \frac{(1.0/n)(R^{2/3})(s^{1/2})}{R^{2/3}} \) and outputs are in meters. To test metric, set to metric in Drawing Setup. Then for a rectangular, concrete open channel of 12.0 meters width, slope of 0.28%, Manning’s n of 0.013 and depth of 2.5 meters, you should compute a velocity of 5.94 m/s and Q (flow) of 178 cubic meters/second.

**Prompts**

**Channel Design (Manning's Eq) dialog:** Fill in values.

**Pulldown Menu Location:** Structure in Hydrology

**Keyboard Command:** channel1
Channel Design - Erodible Mannings Equation

This command uses the same Manning’s equations as non-erodible channel design. In this case, the discharge and velocity are known. The velocity must be less than a maximum to prevent erosion. The program calculates the channel dimensions that meet the requirements.

First choose the channel and water type. Then either enter the Manning’s n, velocity, and tractive force or select them from a table of channel types by clicking Select from Table. Also fill in the slope and discharge. Finally, choose either Calc Base or Calc Ratios to compute the channel dimensions. You may also fill in the channel dimensions and choose to Calc Discharge or Calc Depth. The Standard Parameters are used in drawing the channel detail. When OK is selected, the routine ends and the channel is drawn if Draw Channel Detail is checked.

When choosing Calc Discharge, Calc Base, Calc Ratios or Calc Depth, there will be a message Error: unable to solve these parameters on the top line if the design parameters never reach erosion conditions for any channel dimension. Consider an extreme error case with a discharge of 1 cfs, a slope of 0.1%, and a velocity of 5.0 fps. There are no dimensions that meet these requirements. So, for this case, the channel dimensions can be set anyway to avoid erosion.

Prompts

Channel Design (Erodible) dialog: Fill in values.

Pull down Menu Location: Structure in Hydrology

Keyboard Command: channel2

Prerequisite: None

Grass Channel Design

This feature allows you to design grass lined channels having one of three different cross sections:
1. Triangular
2. Parabolic
3. Trapezoidal

The design methodology that is used is that recommended in Chapter 7, Grass Waterways, Part 650 of the Engineering Handbook published by the United States Department of Agriculture Natural Resources Conservation Service. It uses the equations found in Appendix B of Chapter 7. The solution of the equations is an iterative process and results in several possible cross sections having varied dimensions. The designer must then use engineering judgment to choose the final channel cross section dimensions based on the site layout, machine crossing restraints, excavation equipment to be used, etc.

Basic Design Parameters

Use the entries on the Basic Design tab (see below) to specify the design methodology to use and the basic shape and limiting dimensions of the cross section.

Design Methodology

You may use one of two available design methodologies:
1. Retardance Curves - retardance curves can be used when specific data on the condition, density, height and other information for the grasses being used to line the channel are not available. This method will generally result in a safe but relatively conservative design. In this method the designer must specify one of several available design curves (A through E) for the best and worst grass conditions. (see the Retardance Curve Design tab below)
2. Calculate using grass parameters - this method requires the designer to have a more detailed knowledge of the specific grass being used. This allows the designer to produce a safe design that may not be quite as conservative as the retardance curve method.

Cross Section to Use
Choose the type of cross section you prefer
1. Triangular
2. Parabolic
3. Trapezoidal

Design Requirements

**Design Peak Flow** - Enter the Design Peak Flow (cubic feet or cubic meters per second) as obtained from your watershed model or other source.

**Channel Centerline Slope** - Enter the percent slope of the reach of the channel you are designing.

**Maximum Channel Top Width** - You may specify a starting maximum channel top width. This value will limit the maximum top width that will be considered in the design calculations. This should be set to match the largest channel that your site could accommodate or the maximum that is desirable.

**Freeboard** - Specify how much freeboard you wish to add to the channel depth above the design water flow depth. This is a matter of engineering judgment and should, among other things, consider the consequences of overtopping and the probability that that may happen. You could estimate this value by doing a preliminary design using a more severe flow than the actual design peak flow.

Construction Considerations

**Side Slope Ratio** - specify the minimum slope ratio for the side slopes of the channel. For a parabolic channel this will be the side slope ratio calculated at the water surface. This should be set keeping in mind construction limitations and what types of vehicles or machinery must cross the channel, along with possible erosion due to runoff, etc.

**Min. Channel Bottom Width (optional)** - This field is only available in the case of a Trapezoidal cross section. If this value is not specified a minimum value of 1 foot (or 30 cm) will be assumed. This value should be set to accommodate construction equipment and can also effect ease of crossing by other vehicles or machinery.

**Channel Depth Search Increment** - This value is used to increment the depth of the channel for the iterative solution and thus sets the significant figures used during the design calculations and the resulting design dimensions reported. This value should generally reflect the elevation accuracy expected for the construction of the channel cross section.

Soils

The **Soils** tab of the **Grass Channel Design Parameters** dialog allows you to specify the type of soil encountered along the reach of the channel being designed.

**Non-cohesive Soils:**
If the soil is non-cohesive then check the **Non-cohesive Soil** check box (see below). This means that the soil must have a Uniform Soil Classification System (USCS) classification of GW, GP, SW or SP (well or poorly graded gravel or sand) with a Plasticity Index (PI) that is less than 10.

When the **Non-cohesive Soil** check box is checked the **D75 (75% of soil particles <=)** edit box appears. Specify

![Grass Channel Design Parameters](image-url)
the opening size (in inches or millimeters) of the sieve that 75% of the soil particles will pass through.

**Cohesive Soils**
If the soils have a significant clayey or silty portion and have a PI \( \geq 10 \) then the **Non-cohesive Soil** check box should be unchecked (as shown below).

**USCS Soil Classification** - choose the correct USCS classification of the soil in this reach of the channel from the drop down list  
**Plasticity Index (PI)** - type in the PI.  
**Estimate void ratio based on soil description** - if this checkbox is checked the void ratio will be estimated from the soil description (see below). If it is unchecked the user must specify the void ratio.

**Void Ratio (e)** - enter the void ratio for the soil along this reach of the channel. (shows only if **Estimate void ratio based on soil description** checkbox is **unchecked**)

**Soil Description** - choose the description that best fits the soils encountered along this reach of the channel. (shows only if **Estimate void ratio based on soil description** checkbox is **checked**)

**Retardance Curve Design**
If you chose the **Retardance Curves Design Methodology** on the **Basic Design** tab, then you use this tab to specify the best and worst grass conditions for the design.

**Note:** If you have chosen the **Grass Parameters Design Methodology** and you click this tab, you will only see the message:
*** Using Grass Parameters Design Method ***

in the middle of the window.

**Retardance Curve for Best Grass Condition**

From the drop down list, choose A, B, or C retardance curves to be used for the best grass condition. This condition will control the minimum design depth of the water since grass in its best condition will offer more resistance to flow and cause the water to flow deeper. If you are unsure of which retardance curve to use, choose any one of the curves and read the grass descriptions in the window below the drop down list, then choose the one that fits the expected best site conditions.

**Retardance Curve for Worst Grass Condition**

Use the drop down list to choose the retardance curve (C, D, or E) to be used for the worst grass condition. This condition will control the maximum design depth of the water since grass in its worst condition will offer less resistance to flow and it or the soil may be damaged by flows above this maximum level. If you are unsure of which retardance curve to use, choose any one of the curves and read the grass descriptions in the window below the drop down list then choose the one that fits the expected worst case site conditions.

**Grass Parameters Design**

If you chose the Calculate using grass parameters Design Methodology on the Basic Design tab, then you use this tab to specify the grass parameters for the best and worst grass conditions for the design.

**Note:** If you have chosen the Retardance Curve Design Methodology and you click this tab, you will only see the message:

*** Using Retardance Method for Design ***

in the middle of this window.

When using the Grass Parameters design method you may choose to use one of three methods to specify the cover factors (CF) for the best and worst grass conditions. Cover Factors describe the ability of the vegetal cover to reduce the maximum hydraulic stress on the soil and is related to the type and quality of the vegetal cover. The three available options are described below.

**Estimate Cover Factors from general grass description**

When you click the Estimate Cover Factors from general grass description radio button, the items that are visible in the dialog are as shown below:
**Grass Variety** - choose the grass variety that will be used to line the channel. If you cannot find the variety you wish to use in the list then choose **Other** (at the bottom of the list).

**Grass Category** - choose the general category of the grass to be used to line the channel. (this item only shows if you chose **Other** as the Grass Variety)

**Best Grass Condition**
Choose the condition category that describes the expected best grass condition.

**Worst Grass Condition**
Choose the condition category that describes the expected worst grass condition.

**Directly enter Cover Factors**
When you click the **Directly enter Cover Factors** radio button the items visible in the dialog are as shown below:
Best Grass Condition

Cover Factor (Cf) - Enter the cover factor for the expected best grass condition.

Max. Retardance curve index - enter the maximum retardance curve index for the expected best grass condition.

Worst Grass Condition

Min. Retardance curve index - enter the minimum retardance curve index for the expected worst grass condition.

Note: The retardance curve index values for the various SCS retardance classes have been published in the publication quoted in the first paragraph of this help item and can be used to estimate the retardance curve index to use:

retardance Class retardance curve index (Ci)
A 10.0
B 7.64
C 5.60
D 4.44
E 2.88

Calculate Cover Factors from detailed grass parameters

If you click the Calculate Cover Factors from detailed grass parameters radio button, the items appearing in the dialog are as shown below:
Grass Variety - use the drop list to specify the grass variety to be used to line the channel. If none of the varieties listed are suitable you can choose Other.

Grass Category - choose the general category of the grass to be used to line the channel. (only appears if Grass Variety chosen is Other)

Best Grass Condition
Maximum Stem Density - enter the estimated stem density for the best grass condition
Maximum Stem Height - enter the estimated stem height for the best grass condition

Worst Grass Condition
Use the drop down list to choose the condition category that best fits the expected worst grass condition.
Minimum Stem Density - enter the estimated stem density for the worst grass condition
Minimum Stem Height - enter the estimated stem height for the worst grass condition

Once you have specified the basic design, soil, and grass parameters you can click the Calculate button. If no data entry errors are detected, the input data and the resulting channel design(s) will be listed on the Results tab.

Results

After the design calculations have been made, the input data and the resulting channel design information will be listed on the Results tab.
To view the channel design cross section information in this window, you merely left click on the scroll bar, hold the mouse button down and drag the scroll bar downward.

The Results listing starts with a recap of the design parameters and the resulting calculated maximum allowable stresses for the soil and the vegetation. Below that begins a list of channel configurations that satisfy the specified design parameters and thus will safely carry the design peak flow (with some freeboard - if specified). The channel geometry is described in six columns for a trapezoidal channel and in five columns for both triangular and parabolic (neither triangular nor parabolic have a bottom width column). The columns are labeled: Top-Width, Base-Width, Flow-Depth, Channel Depth, Side Slope Ratio, Excess.
(only for trapezoidal), Flow-Depth, Chan-Depth, Side-Slope-Ratio, and Excavated-Area. The units will be specified according to the unit settings specified in Carlson Configure or CG Options. The Flow-Depth and the Chan-Depth will only differ if freeboard is not zero.

**Note:** If no safe design is possible for the specified input parameters the following message will appear below the column titles:
**No valid channel cross section can be determined given specified parameters**

**Viewing, printing and/or saving the design report**

To view the design report click the **Report** button. The report will come up in the Carlson Editor, an example of which is shown below.

You can now view the input data and the results as well as save them to a text file and/or print them.

**Draw the design channel cross section**

Once the design calculations have been completed and the Results tab is showing, review the available channel geometries and choose the design you wish to use. To choose a design to be drawn to the current drawing, highlight the desired geometry on the Results tab as shown below:
After highlighting a specific design geometry by clicking on that line, click the Draw button to draw the channel cross section in the current drawing. This will bring up the **Draw Grass Channel Settings** dialog (see below).

### Draw Grass Channel Settings

**Scale** - enter the scale at which the channel cross section is to be drawn. This may default to the current scale of your drawing but may be changed to a larger or smaller scale.

**Channel Cross Section Layer** - specify the layer on which the channel cross section lines are to be drawn. You may choose an existing layer by using the drop down list or you may specify a new layer by typing it in. If you specify a layer that does not currently exist, the layer will be created.

**Water Surface Layer** - specify the layer on which the water surface line is to be drawn. You may choose an existing layer by using the drop down list or you may specify a new layer by typing it in. If you specify a layer that does not currently exist, the layer will be created.

**Dimension Layer** - specify the layer on which the channel dimensions are to be drawn. You may choose an existing layer by using the drop down list or you may specify a new layer by typing it in. If you specify a layer that does not currently exist, the layer will be created.

**Dimension text height** - specify the height in plotted inches.
**Dimension rounding** - use the drop down list to specify the number of decimal places to be used for the dimensions.

Once the settings have been specified, click the **OK** button to proceed with the drawing or **Cancel** to return to the **Grass Channel Design Parameters** dialog.

If you clicked the **OK** button you will be returned to the drawing with the following command line prompt:

**Pick location for channel cross section drawing:** pick a point on the screen for the upper left hand edge of the cross section.

The channel cross section will then be drawn (see an example below) and you will be returned to the **Grass Channel Design Parameters** dialog where you can choose to draw another cross section from the current design list or enter the design parameters for a redesign of the current reach or the design of another reach of this or another channel alignment.

When all designs are completed and you wish to close the dialog, click the **Exit** button.

**Prompts**

Use the dialog as described above.

When drawing the cross section, this prompt will appear:

**Pick location for channel cross section drawing:** pick a point on the screen for the upper left hand edge of the cross section.

**Pulldown Menu Location:** Hydrology Menu - Structure > Channel Design > Grass

**Keyboard Command:** cg_grass_chan

**Prerequisite:** None

**Pipe Culvert Design**

A culvert is a hydraulically short conduit, which can be used to convey stream flow underground through a roadway embankment or other flow obstructions, or used as an outlet structure attached to a detention pond. Culverts come
in circular and rectangular cross sections, and concrete, corrugated steel, aluminum and plastic materials.

The hydraulics of a culvert are complex since several flow control types may exist. The methods that Pipe Culvert Design uses are from FHWA Hydraulic Design Series No. 5 (HDS-5), Hydraulic Design of Highway Culverts. There are two flow controls: inlet control and outlet control. Under inlet control, the culvert’s entrance characteristics determine it’s capacity, and the culvert is capable of conveying a greater discharge than the inlet will accept. With outlet control, the inlet can accept more flow than the culvert can carry because of the head loss due to the friction along the barrel or the high tailwater elevation. Furthermore, because culverts are generally not long enough to achieve uniform flow, the flow profile inside is often gradually or rapidly varied flow. In Pipe Culvert Design Settings dialog, you may specify the flow control type to design the culvert. If you choose the Optimum option, both inlet control and outlet control calculations are performed, along with the gradually varied flow analysis. The worst-performing control condition is then used to evaluate the proposed design, i.e. the greater of the inlet control headwater and the outlet control headwater is the controlling headwater. Please refer to HDS-5 for details.

From the Structure menu in the Hydrology Module, choose Pipe Culvert Design to display the design dialog. Click on Load button to load an existing culvert file to view or modify it, or a new file to start a fresh design. From the Solve For list, select the value that you want to calculate. The available values are: Discharge, Headwater and Size. You may choose Size/Discharge or Size/Headwater to compute the exact discharge or headwater values after the size has been solved.

**Culvert Design**

**Culvert Section**

From the Shape list, select the type of culvert that you want to define. The available shapes are Circular and Box. From the Material list, select the material for the culvert such as Concrete or CMP/Aluminum. You can use the Library function next to Material to select the material and manning’s n from the pipe material library and to edit or add to this library. If you don’t solve for the culvert size, enter the values in the Diameter box or Height and Width boxes depending on the culvert shape. In the Manning’s n box, type a Manning’s n roughness coefficient for the culvert. Please refer to Pipe Manning’s N Library command for defining Manning’s n values. In the Number of Barrels box, enter the number of barrels for the culvert.

**Culvert Inlet**
The Inlet list contains the different inlet types available for the current culvert shape. It updates with different culvert shape that is chosen. All the inlet types are specified in HDS-5. Ke is the entrance loss coefficient, which is depending on the culvert shapes and inlet types. It'll update with different chosen culvert shape and inlet type, you can also type the value in the box.

**Culvert Inverts**

Inlet Invert is the elevation of the bottom of the culvert at the upstream end, while Outlet Invert is the elevation of the bottom of the culvert at the downstream end. In the Length box, enter the true culvert pipe length. The culvert slope will be calculated after entering the above three values and displayed in the Slope box. You may also change the outlet invert by entering a slope for the culvert. The most efficient way to get the culvert parameters filled is to select the 3D polyline that represents the culvert. Pick button allows you to pick a 3D point that represents the Inlet/Outlet invert.

**Calculation**

In the Discharge box, enter the rate of flow in the culvert. In the Headwater Elev box, enter the water surface elevation at the upstream end of the culvert. You can also enter the Headwater Depth then the program will add the depth value to the inlet invert to get the headwater elevation. If you are solving for either discharge or headwater, the corresponding box will be disabled. In the Tailwater Elev box, enter the water surface elevation at the downstream end. Section Size Library allows you to specify as many as available pipe sizes for solving for culvert size. After the hydraulic calculation, the smallest, large enough, available pipe size will be chosen. Please refer to the Pipe Size Library command for defining pipe sizes. Click on Solve button, depending on Solve For selection, the headwater, discharge, culvert size are calculated and displayed in the dialog corresponding. The Outlet Velocity and Flow Depth are calculated and shown, and the Control Type is also illustrated.

**Outputs**

Click on the Stage-Discharge Result button to display the stage-discharge curve in the Stage-Discharge Result Dialog. From this dialog, you can view the stage-discharge curve, write the result to a stage-discharge file (.STG), and draw the graph into the CAD graphic. When you click on the Draw button, the Stage-Discharge Curve Settings dialog displays from where you can define how to plot the text and graph on screen.

![Stage-Discharge Limits](image-url)
Stage-Discharge Dialog

Click on Generate Report button, the program will present a report screen that contains detailed information regarding the design parameters and the calculations. The report window provides the options of printing, drawing the report in AutoCAD or storing the report to a file. Shown below is an example.

Culvert Report

A rating table presents the discharge-headwater relationship in the tabular form. It can be displayed in a Microsoft spreadsheet or a standard report. Click on Generate Rating Table button to open Rating Limits dialog. In the Variant list, select the independent variable. The available variables are Discharge and Headwater. Enter data in the Minimum, Maximum and Increment boxes. Enter the Tailwater Elev and select the decimal setting from the Decimals list. When you finish entering data, click on OK button to calculate the rating table. A rating table example is shown below in the standard report format. The first column Discharge is an independent variable, and the other columns are computed variables.
Culvert Rating Table Limits

Culvert Rating Table in Report Format

Generate Sedcad File button produces a file with a .CVT extension that can be used as one of the building blocks for the SedCad Program (a third hydrology and sedimentology stand-alone software package). The file is identical to what is produced within SedCad by its utilities program. Draw Pipe Detail button plots a fully annotated standard detail, with user-controlled inlet and outlet slope entries and scaling.
Prompts

**Culvert Design dialog:** Fill in values

**Pulldown Menu Location:** Structure > Pipe Culvert Design

**Keyboard Command:** culvert

**Prerequisite:** a culvert file

---

**Sewer Pipe Design: Individual**

This command calculates the travel time, flow depth, and velocity for a section of pipe. It calculates for one pipe section using the dialog shown here. Pipe sections can be entered as upstream/downstream stations and elevations, or as length and slope. Clicking Calculate will give you Design Output data based upon your input. Follow up Calculate by clicking Report, which will give you the Standard Report Viewer. Even after reviewing the information in the viewer and clicking on the viewers' Exit button, or its other output buttons, you still have the opportunity to change your original dialog box entries. This is because the command cycles from the viewer back into the dialog box for modifications. The Draw Pipe button draws the pipe details on the screen. The Exit within the dialog ends the command.
Prompts

**Sewer Pipe Design dialog** Fill in variables. Click Calculate, then click Report.

Report results from the Standard Report Viewer:

**Sewer Design**
- **Upstream Station: 0.000 Invert Elev: 395.400**
- **Downstream Station: 400.000 Invert Elev: 390.400**
- **Flow Rate (GPM): 50.00**
- **Pipe Diameter (in): 8.00**
- **Manning’s n: 0.020**
- **Length (ft): 400.00**
- **Slope (ft/ft): 0.0125**
- **Travel Time (min): 3.86**
- **Flow Depth (in): 1.92**
- **Velocity (fps): 1.73**

**Pulldown Menu Location:** Structure > Sewer Pipe Design > Individual

**Keyboard Command:** swrpipe

**Prerequisite:** None

**Sewer Pipe Design: Sewer Network Segment**

This command reads a sewer network and displays every pipe segment in the Sewer Pipe Design dialog. From the Structure > Sewer Pipe Design menu in the Hydrology Module, select Sewer Network Segment. The function reads a sewer network file, conducts the hydraulic calculations and displays pipe parameters and results in the dialog. Pipes list contains all pipe segments, you can select any one of them to display its data. The pipe parameters are shown in the middle part of the dialog, and the results are shown in the bottom table. Load button loads another
Sewer Pipe Design: Sewer Network Segment

**Prompts**

**Sewer Network Segment dialog:** Fill in values.

**Pull-down Menu Location:** Structure > Sewer Pipe Design > Sewer Network Segment

**Keyboard Command:** swrpipe3

**Prerequisite:** a sewer file (.SEW), ...

inlet.dta, ...

pipesize.dta (mpipesize.dta in Metric unit)

**Sewer Pipe Design: Read Profile**

This command calculates the travel time, flow depth, and velocity for a section of pipe. It reads the stations and elevations of a sewer or pipe profile (.PRO) created by the Design Sewer/Pipe Profile command in the Civil Design module. Pipe sections can be entered as upstream/downstream stations and elevations or as length and slope.

**Prompts**

**Flow rate units [<GPM>/CFS]?, press Enter**

Flow rate <0.0>: 50

Manning's n for pipe <0.020>: .02

Specify a Profile File dialog select existing sewer or pipe .PRO file

Number of decimal places <2>: press Enter

Report results from the Standard Report Viewer:

<table>
<thead>
<tr>
<th>Station</th>
<th>Invert-IN</th>
<th>Invert-OUT</th>
<th>Distance</th>
<th>Slope</th>
<th>Width(in)</th>
<th>Depth(in)</th>
<th>Time(min)</th>
<th>Velocity(fps)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+40.44</td>
<td>61.80</td>
<td>61.80</td>
<td>285.53</td>
<td>2.50%</td>
<td>10.00</td>
<td>1.51</td>
<td>2.21</td>
<td>2.15</td>
</tr>
<tr>
<td>3+25.88</td>
<td>68.94</td>
<td>68.94</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Lift Station Design

This command aids in the design of duplex sanitary or storm sewage lift stations. The program assumes a duplex station, with the second pump used solely for backup. That is, there are no provisions for multiple pump operation. The system head curve and pump curve are calculated using the least squares method of curve fitting through three points. To calculate the three points input the length of the force main (length of pressurized pipe), an assumed low-level wastewater surface elevation in the wet well, the elevation of the static lift in the force main, the sum of minor loss coefficients in the force main, and three flow rates that adequately cover the desired range of pump operation. The total dynamic head is calculated for each of the three flow rates by adding the static head, friction losses, velocity head, and minor losses that are calculated by the program from the input data. The next step is the calculation of the pump curve. The user should select one or more pumps from a manufacturer's catalog that will produce the desired operating conditions. The input data consists of the pump shutoff head (flow rate equal to zero), a head and flow rate near the desired operating point, and a head and flow rate beyond said operating point of the pump curve.
The system head curve and the pump curve are then intersected to produce preliminary operating point results. If the user is not happy with the results, click the Edit Input Values button and change any of the parameters. When the user attains the desired results then proceed with the wet well design by clicking OK.

Input for the wet well design includes type of wet well, wet well dimensions, invert elevation of the lowest line entering the wet well, and minimum wastewater depth in the wet well (usually specified by the pump maker). The lead pump's wet well volume is calculated using a formula from Metcalf & Eddy’s Wastewater Engineering: Collection and Pumping of Wastewater: \[ V = \frac{CT}{4}, \]
where \( V \) equals required volume in gallons, \( C \) equals pump capacity (GPM), and \( T \) equals minimum time in minutes of one pumping cycle. After wet well design the program assigns a new low level wastewater surface elevation in the wet well, and then recalculates the system head curve and final operating point. At this point the user may change any or all of the input parameters. If no changes are needed then click OK to show the Final Results report.
Network Menu

The Network pull-down menu has commands for layout and analysis of storm sewer networks.

Network Menu

Sewer Network Settings

This command sets up the working environment for the design and analysis of sewer, sanitary and utility networks and should be done before starting the construction of networks.

Network Type: Indicate if the sewer network conveys storm runoff flow (Storm Sewer) or man-made flow (Sanitary/Utility). If the Sanitary/Utility network type is specified, the controls found in the Drainage tab are disabled.
Active Files: Select a new or existing sewer (.SEW) file to become the active sewer file and a "surface file" for ground cover calculations:

- **Surface by Rim Elevations** - When this option is enabled, the ground surface elevation is derived as an interpolated grade from structure rim elevation to structure rim elevation and the Surface Model option is disabled, or,

- **Surface Model** - When the Surface by Rim Elevations option is disabled, select a valid surface model (.TIN, .FLT, .GRD) that blankets the sewer network. The ground surface elevation is obtained from the surface model along the pipe reach.

**Link Sewer Network to Reference Surface and Centerlines:** Indicate the method of how the sewer network should react if there are changes to either the specified Surface Model or any related Centerlines that are specified in either the Create Sewer Structure command or the Edit Sewer Structure command. The following types of corrections can be made:

1. If the reference Surface Model changes, the structure rim elevation can be updated and there are two options for updating the invert elevation, discussed in the Elevation Update Method section below.
2. Each structure has the option to assign a reference centerline and the structure will record the station and offset from this centerline. When the reference centerline of a structure changes, the structure can be moved to the position of the recorded station and offset along the newly modified centerline.

Depending on the desired level of end-user control vs. automation, one of the following corrective options can be specified:

- **Off** - When a Surface Model or a Centerline changes, corrective action to the sewer network is not performed. Any corrections to the sewer network will need to be performed manually or through the use of the Check Reference Centerlines and Surface command which will compare the sewer network with the referenced file(s),
- **Prompt** - When a Surface Model or a Centerline changes, you will be offered a choice for a follow-up action of whether to update the structures or not.
- **Auto** - When a Surface Model or a Centerline changes, corrective action is automatically performed on the sewer network and any elevation updates will be calculated based on the Elevation Update Method.

**Elevation Update Method:** Indicate how the invert elevation(s) should change as a result of a change to a Surface Model (when the "linking" method is set to Auto):

- **Update Depth, Hold Inverts** - When this option is selected, the former invert elevations are retained and new depth of cover amounts are re-calculated, or,
- **Update Inverts, Hold Depth** - When this option is selected, the former depth of cover amounts are retained and new invert elevations are calculated.

The SaveAs button saves all the settings to a .SNS file and Load button loads all the settings from a previously saved .SNS file.
**Direction:** The network can be designed from Downstream to Upstream or vice versa. If the design direction is from Downstream to Upstream, the first structure created is generally the outfall and the current structure and its downstream pipe are highlighted in the plan view. Otherwise, the network is created from one of its entrances toward the eventual outfall and the current structure and one of its upstream pipes are highlighted.

**Auto Set All Sewer Pipe Sizes:** When enabled, this option disables the *Pipe Size* control found on the Pipe tab of the Create/Edit Sewer Structure command and sizes the pipe(s) automatically to the closest available pipe size as specified in the Pipe Size Library.

**Auto Set All the Invert Elevations of the Sewer Network:** When enabled, this option:

1. calculates initial *Invert* elevations found on the Structure tab and the Pipe tab of the Create/Edit Sewer Structure command, and,
2. enables the *Add Step Up to Minimize Excavation* control, and,
3. disables the *Auto Match Pipes at Junction* control.

**Add Step Up to Minimize Excavation:** When enabled, this option allows pipe inverts to be placed above the current invert elevation up to the *Max. Step Up* value to minimize excavation and create a potential "drop manhole."

**Auto Match Pipes at Junction:** When enabled, this option sets the pipe inverts automatically when creating a new pipe in order to match it to other pipes at the same junction.

**Minimize Pipe Sizes in Design:** When enabled and if the sewer network is being designed, this option will ensure the pipes are not over sized as extra calculation iterations are performed.

**Automatic Watershed Analysis:** When enabled, this option performs an automatic watershed analysis of the referenced *Surface File* found on the General tab to determine the drainage area serviced by the new structure. This action is the same as clicking the *Drainage Area - Calc* button found on the Drainage tab of the Create/Edit Sewer Structure command.

**Auto Connect Structures:** This option determines how to connect a newly created structure to the network:

- **On** - Automatically connects a pipe between the new structure and the previous structure, or,
- **Off** - Does not connect a pipe to the newly created structure (the structure would need to be manually connected to the network via the *Connection* control found on the Pipe tab of the Create/Edit Sewer Structure command or,
• **Prompt** - Provides an option as to whether or not a pipe should connect to the new structure.

**HGL Computation Method**: You may choose between the Carlson Method or Virginia DOT Method.

**Friction Slope Averaging Method**: Available methods are:

- **Arithmetic** - $S_{fav} = (S_{fu} + S_{fd})/2$, or,
- **Conveyance** - $S_{fav} = ((Q_u + Q_d)/(K_u + K_d))^2$, where
  - $Q$ = Flow
  - $K$ = Conveyance = $(1.486/n)*a*r^{2/3}$ (based on English units)
  - $n$ = Manning’s $n$-value
  - $a$ = Flow area
  - $r$ = Hydraulic radius
- **Geometric** - $S_{fav} = (S_{fu} * S_{fd})^{1/2}$

**Tailwater Elevation At Outfall**: Enter the water surface elevation at the outfall.

**HGL Offset from Rim Elev**: This value is used to check the hydraulic grade line result. If some of the hydraulic grade lines are within this value from the rim elevation, alerts are presented to indicate the potential problem(s).

The drainage settings are used to set up the hydrology calculation method and rainfall information for the design of Storm Sewer networks.

**Hydro Methods**: Select either the Rational method (the SCS Rainfall group becomes disabled) or SCS method (the Rational Rainfall group becomes disabled) for Peak Discharge calculations.

**Computation Methods**: Indicate the computation method for the Storm Sewer network:

- **Peak Discharge** - The Rainfall Durations are disabled and the peak flow of each drainage area is calculated by the selected Hydro Method and the Storm Sewer network is designed to pass the peak flow, or,
- **Hydrograph** - The Rainfall Durations are enabled and a runoff hydrograph of each area is generated and routed through the network.

**Use Different Rain Event for Inlet Gutter Spread and Ponding Depth Calculation**: When enabled, this option enables an alternate rainfall event for either Rational or SCS calculation methods to determine inlet efficiency.
**Rational Rainfall:** Specify the Rainfall, Return Period and Duration (if using the Hydrograph method) if using the Rational equation.

**SCS Rainfall:** Specify the Antecedent Moisture Condition, Storm Type and rainfall map if using the SCS methodology.

**Always Capture All Inlet Flow (Bypass Disabled):** You may elect to let the inlets to capture all drainage runoff.

**Min. Time of Concentration:** This value will replace any calculated $T_c$ that is shorter than this value.

**Max. Gutter Spread:** Indicate the largest allowable gutter spread for determining inlet effectiveness.

![Sewer Network Settings](image)

**Cover:** Enter the minimum and maximum depth of cover which is the distance from the surface elevation to the crown elevation along the pipes. Alternatively, enable either (or both) Library toggle(s) to use the value(s) specified in the Pipe Size Library.

**Velocity:** Enter the minimum and maximum flow velocity for the pipes. The minimum velocity is about 2 to 3 ft/s (0.6 to 0.9 m/s) when the pipe is flowing full for self-cleansing. The maximum velocity should be less than approximately 15 ft/s (4.5 m/s) to prevent erosion of the pipe interior by suspended sediment and debris. Alternatively, enable either (or both) Library toggle(s) to use the value(s) specified in the Pipe Size Library.

**Slope:** Enter the minimum and maximum slope range for the pipes in the network. The minimum slope should be sufficient to maintain the minimum velocity and the maximum slope is related to the maximum velocity. Alternatively, enable either (or both) Library toggle(s) to use the value(s) specified in the Pipe Size Library.

**Normal Slope:** The normal slope is the initial slope used to place a pipe in the network.

**Max. Length:** This is the maximum length between structures in a network before an alert is presented indicating a potential problem.

**Drop Across Junction:** This is the drop across the inside of a junction. Depending on the Direction specified on the Design tab, the Invert Up is either raised by this amount or the Invert Down is lowered by this amount.

**Pipe at Junction Match by:** Indicate if pipes should be aligned by their inverts or crowns.

**Main Design Criteria:** Indicate which criteria should be maintained if both the Minimum Cover and Minimum Slope cannot be satisfied. If Cover is selected, the Slope will yield and vice versa.
Check Min. Cover: Define whether to check the minimum cover at the structures only or along the entire length of each pipe.

Size Pipe At Target Flow Depth: When this option is enabled in design mode, the sewer pipes will be set to the sizes that are sufficient to maintain the target flow depth.

Check Collision with Another Sewer Network During Design: When enabled, this option allows for potential conflict detection with another sewer network. Should the placement of a structure or pipe encroach on the Conflict Tolerance, an alert will be displayed to caution against the potential collision.

Check Circular Manhole Size: When enabled, this option will check if the manhole is big enough to hold the incoming and outgoing pipes and will display an alert if any of the settings are violated.

Show Pipe Crossings: When enabled, this option allows you to display the pipe crossings of current network opposed to any sewer networks or pipes that are drawn in the drawing.
**Pipe Length**: Specify how the pipe length should be displayed.

**Pipe Slope Annotation**: Specify how the pipe slope should be displayed.

**Display Slope In**: Specify to display slope in the unit of either distance/distance or %.

**Elevation Decimals**: Indicate the desired amount of precision to display for elevation values.

**Show Circles**: Places circles of max pipe length while placing structures.

**Lateral Cleanout**: Specify lateral cleanout symbol.

**Lateral Connection**: Specify lateral connection symbol.
Pulldown Menu Location(s): Network > Sewer Network Setup  
Keyboard Command: swrconfig  
Prerequisite: None  

Lateral Design Overview

Lateral design is available in both the storm sewer and sanitary sewer design programs. A lateral pipe is very much like a regular pipe in sewer network. It is a pipe between a lateral connection, inserted at the main pipe line, and a lateral cleanout that goes into the lot. The Lateral Connection and Lateral Cleanout are specific types of sewer structures, which can be defined in Sewer Structure Library. The lateral connection has a property of offset elevation relevant to the mainline sewer invert at the point of connection. The lateral cleanout is a circular structure with the same bottom and top diameters.

There are lateral specific parameters for the riser height, station at riser end (measured from mainline to cleanout) and the basement floor elevation.

For Draw Sewer Network in Plan View, Draw Sewer Profile, Report Sewer Network and Edit Sewer Network in the spreadsheet, the main line pipe will be shown from MH to MH. In plan view, you can label lateral station at the lateral connections (measured for its downstream MH). In draw sewer profile, the lateral connection labels are separated from pipe crossing labels so that lateral connections can have different label settings. Spreadsheet Sewer editor is able to edit both main line pipes and lateral pipes.

The following is the procedure of creating and editing laterals when working on a storm or sanitary sewer network.

1. Create a new lateral

Click on the Add button for new structures and choose the option "Add Lateral from Cleanout Point". Then pick a location to create the cleanout structure, and snap main pipe line to insert the lateral perpendicularly. Once the intersection point is determined on the main line, the elevation of the downstream end of the lateral is set to the mainline invert at the intersection, plus the offset value defined in the connection structure.
If this is the first lateral in the network, the program checks the Sewer Structure Library to get the first lateral cleanout and connection structure in the list. Otherwise the last used pair will be used. If there is no lateral cleanout or connection structure in the library, the lateral becomes a regular pipe.

2. Edit a lateral

Editing a lateral is similar to a regular pipe. The lateral can change to a regular pipe if the end structures are changed to manhole structures. The lateral is perpendicular to the main pipe line when it is created at the beginning, but it can be relocated along the mainline by the Location button. The invert elevation of both ends of the lateral can be modified as same as a regular pipe.

**Set Sewer File**

This command sets a sewer network file as the current file. The other sewer network commands will reference this file. Either a new file can be created or an existing sewer file can be modified. The sewer network file stores all the sewer structure data (elevation, flow) and all the network connection data (slopes, pipe sizes). This file has a .sew file extension.

**Pulldown Menu Location:** Network  
**Keyboard Command:** setswr  
**Prerequisite:** none

**Set Surface File**

Use this command to set the grid or triangulation file to be used to compute sewer manhole surface elevations and minimum cover along pipe lengths, within the Sewer Network commands, and in particular the command Create Sewer Structure. A dialog will appear requesting the name of the surface file to be used.

**Pulldown Menu Location:** Network  
**Keyboard Command:** setgrd  
**Prerequisite:** None

**Plan View Label Settings**

This command sets the drawing format for sewer pipeline and inlet/manhole annotations drawn for the sewer network. The settings are entered in a dialog with tabs for Structure Labels, Pipe Labels and General Settings. Shown below is the manhole or inlet name, along with rim elevation, invert elevation and the labeling of the sewer pipe itself. When the network entities are selected by the 3D Viewer Window command, they are automatically converted into 3D entities.
Under Structure Labels, you can choose whether to label the structure name, structure description, northing, easting, rim elevation, depth, station, offset, inlet type, invert-in elevation, invert-out elevation, structure ID, Inlet ID or custom offsets. The custom offsets label elevations relative to either the structure rim elevation or invert elevation with a specified offset. The list of available fields is on the left and the list of fields to label is on the right. The order of the fields in the right side list is the order of the labels in the drawing. Use the Add, Remove and Up/Down arrow buttons to move fields between the lists and change their order. To edit the parameters for a field, highlight the field name on the right list and pick Setup. You can set the label prefix and suffix and whether to start a new row. If new row is off, then the field will be put on the same row as the previous field in the list. The station and offset values are calculated from the reference CL that is assigned to the structures in the sewer network. The invert elevations can be positioned either above the structure or along the associated pipe direction. For Inverts, the Add Quadrant option adds the bearing quadrant of the associated pipe direction to the invert label prefix. The options for Label Format are Individual Labels, Data Table and Attribute Block. For Individual Labels, the program draws regular text entities. The Use MText option will draw the labels as MTEXT entities. Otherwise they are drawn as TEXT entities. The Data Table method will put the labels in a block as shown below. There are settings for the size of the block columns and the block label justification. The Attribute Block method inserts a block and puts the labels into the block attributes. The Align By Centerline option will rotate the labels to be parallel with the pipe. Otherwise the labels are drawn horizontal to the current twist screen. The Locate Only Direction Changes will only label when the pipes to the structure have a deflection angle. This setting applies to utility networks that have a lot of nodes in straight lines and you only want to label the end nodes. The Label Only When Structure Assigned Structure ID option will only draw the structure labels when the structure has an ID other than None. This option is meant for clearing up unnecessary labels for cases like utility networks that have a lot of structures without ID's.
Under Pipe Labels, you can choose whether to label the pipe size, material, length, name or slope. For each label, there are settings for the prefix and suffix and for whether to put the label above or below the pipeline. For length and slope, the labels can be based on structure center-to-center or actual pipe dimension that removes the width of the structure and goes from the structure edges. The Pipe Direction Label has two styles for flow direction arrows. The Draw Line Type sets the method for drawing the pipelines as 2D polylines, 3D polylines or parallel 2D polylines set apart with the width of the pipe. The Draw Pipe Thickness will show the thickness of the pipe with the option to hatch. The Stack Labels For Short Pipes option will automatically make a stacked row of labels when the pipe segment is too short to fit on a single row. The Deflection Angle options have separate prefix/suffix settings for left and right, and the label rotation can be horizontal to the current screen view or perpendicular or parallel to the pipe.
For Lateral Settings, the only option whether to station distance from the lateral connection to the downstream structure.

Under General Settings, there are controls for the layers, styles, decimal places, sizes and linetypes. The linetype is only used when the pipe is draw as a 2D polyline. The Link Labels With Network option determines how to update the labels when the sewer network data is modified. The Create ESRI MSC Attributes option will tag the network entities with ESRI format feature attributes which ESRI version 9.3 and higher will recognize as the specified feature names instead of plain CAD entities.
You are free to move the text anywhere desired for better appearance after it plots. The labeling will change automatically on the drawing if any of the sewer network information is edited or if the label settings are changed. This automatic redraw will put the labels back in their original positions if you moved the labels with standard drafting edit tools. If the Move Sewer Label command is used, the labels will stay at their modified position even after the automatic redraw. The labeling and manhole itself will be removed from the screen by the command Remove Sewer Structure, along with connecting pipe sizes and invert elevations of the immediate upstream and downstream manholes. The command Draw Sewer Network–Plan View will also redraw and label the sewer network that is "set" and current, according to the annotation parameters of this command.

**Pulldown Menu Location:** Network  
**Keyboard Command:** swrsetup  
**Prerequisite:** None

---

**Save Sewer Network File**

This routine re-saves the current sewer network file in another name, which can act as a backup file or "snapshot" of the sewer network design at a certain point in time. The file can be re-loaded later and re-used.

**Pulldown Menu Location:** Network  
**Keyboard Command:** save_sewer  
**Prerequisite:** Sewer network (.SEW) file

---

**Import Haestad Network**

This routine converts Haestad files into Carlson sewer files. Haestad sewer network files have fourteen pieces of information in an ASCII text file. Unfortunately, they do not contain two-dimensional coordinates of the manholes locations. Therefore, the routine must assume locations along some arbitrary datum. Examine the example output below. The program searches for the longest path along the sewer network, and places it on the X axis. The next longest set(s) of network traces branch from the longest path. The process is repeated until the last upstream manhole on the network tree branches is encountered. While true coordinate locations of the manholes is unknown, additional hydraulic analysis of the system can be made on this Carlson pseudo-layout.

---

Chapter 7. Hydrology Module 1751
Rainfall Library

Rainfall is the source of the ground runoff. Along with the watershed conditions, the rainfall that neither infiltrates nor gets trapped in low areas and depressions contributes to the direct surface runoff, upon which the storm drainage system design is based.

The Rainfall Library uses IDF curves to provide average rainfall intensity data for particular storm events. With a known rainfall duration and frequency, an intensity is calculated via the IDF curve and applied to the Rational Method to obtain the peak flow for designing the sewer network. There are six methods to input rainfall data: TP-40 rainfall map, Hydro-35 rainfall map, rainfall accumulation, rainfall intensity, IDF equation coefficients and fixed rainfall intensity. Rainfall maps provided by government organizations are practical rainfall data resources for engineering design. TP-40 maps show precipitation depths in the US for storm durations from 1 hour to 24 hours and for recurrence intervals from 1 to 100 year. Hydro-35 maps are for the central and eastern US, and provide rainfall data for durations as short as 5 minutes. Please refer to HEC-12 for details on methodology for computing IDF curves from rainmaps. In addition to TP-40 and Hydro-35 method, you can input rainfall accumulations or intensities at various storm durations to define IDF curves. If you already have the IDF equation coefficients calculated, you can enter the coefficients directly to define the IDF curves. The IDF curves are interpolated linearly between the data points. If you choose to use fixed rainfall intensity, no IDF curve is calculated and this value is used directly. You may also input rainfall intensity data with lookup table method, where IDF curve is not used, rainfall intensity will be interpolated linearly from the lookup table.

The IDF equation for a given return period is defined as follows. The coefficients $A$, $B$ and $M$ are calculated by log-log regression of the rainfall intensity and $(t + B)$.

$$I = A / (t + B)^M$$

where: $I =$ rainfall intensity (in/hr, or mm/hr in metric)
$A$, $B$, $M =$ equation coefficients for a given return period
$t =$ rainfall duration (min.)

The Rainfall Library stores rainfall data in a library file under the ...\USER folder and is available for all projects.
From the Network > Sewer Network Libraries menu in the Hydrology Module, select the Rainfall Library to open the library dialog to edit rainfall data. The dialog lists all rainfall entries by their ID and their input/edit method. New button creates a new rainfall through one of the five methods: TP-40, Hydro-35, Rainfall Accumulation, Rainfall Intensity and IDF Equation Coefficients. Edit button allows you to modify an existing rainfall, and the Delete button removes the highlighted rainfall from the library. Load and SaveAs buttons allow you to load and save the rainfall data.

**Rainfall Library Dialog**

**New Rainfall Dialog**

**Rainfall Total 2/100 Year (TP-40)**

The TP-40 method is used to define IDF curves for the Western states in the US. It requires rainfall accumulations of 6-hour and 24-hour storm durations for the 2-year and 100-year storms, and the elevation of the location. In the TP-40 dialog, type the rainfall name in the Rainfall ID box. The rainfall depth can be entered either manually or from the TP-40 maps. Click on Map button to open the rainfall map, pick a state on the map to zoom in to the state map, and then pick a location to get the rainfall depth of 6-hour and 24-hour duration for 2-year, 5-year, 10-year, 25-year, 50-year and 100-year storm events. In the Elevation box, enter the surface elevation at the design location. Computation button computes the rainfall intensities and the IDF coefficients, and displays the result in the Rainfall Intensity dialog. Click on OK button to commit the rainfall entry.
TP-40 Rainfall Data Dialog

TP-40 Rainfall Map
Rainfall Intensity Results

Rainfall Total 2/100 Year (Hydro-35)

The Hydro-35 method is used to define IDF curves for the Central and Eastern states in the US. It requires rainfall accumulations of 5-min, 15-min and 60-min storm durations for the 2-year and 100-year storms. In the Hydro-35 dialog, type the rainfall name in the Rainfall ID box. The rainfall depth can be entered either manually or from the Hydro-35 maps. Click on Map button to open the rainfall map, pick a state on the map to zoom in to the state map, and then pick a location to get the rainfall depth. Computation button computes the rainfall intensities and the IDF coefficients at 2-year, 5-year, 10-year, 25-year, 50-year and 100-year return periods, and displays the result in the Rainfall Intensity dialog. Click on OK button to commit the rainfall entry.

Hydro-35 Rainfall Data
Rainfall Accumulation

This method allows you to enter the rainfall accumulations of various durations for any of 2-year, 5-year, 10-year, 25-year, 50-year and 100-year return periods for computing the IDF curves. Add a Duration button adds new duration entry to the spreadsheet. For the accuracy, three or more durations are required. Delete a Duration button deletes the highlighted duration entry. Computation button computes the rainfall intensities and the IDF coefficients, and displays the result in the Rainfall Intensity dialog. Click on OK button to commit the rainfall entry.
Rainfall Intensity

This method allows you to enter the rainfall intensities of various durations for any of 2-year, 5-year, 10-year, 25-year, 50-year and 100-year return periods for computing the IDF curves. Add a Duration button adds new duration entry to the spreadsheet. For the accuracy, three or more durations are required. Delete a Duration button deletes the highlighted duration entry. Computation button computes the rainfall intensities and the IDF coefficients, and displays the result in the Rainfall Intensity dialog. Click on OK button to commit the rainfall entry.

Customed Rainfall Intensities

Enter IDF Equation Coefficients

When you have the coefficients calculated, you can use this method to enter the coefficients to obtain the actual IDF curve equation. In the following spreadsheet dialog, enter the known coefficients A, B and M to create the IDF equation. Computation button computes the rainfall intensities and displays the result in the Rainfall Intensity dialog. Click on OK button to commit the rainfall entry.
This section explains the use of fixed rainfall intensity and rainfall intensity lookup tables in hydrology calculations.

**Fixed Rainfall Intensity**

The method creates a rainfall entry with the fixed rainfall intensity. When you choose to use this storm event, this fixed intensity will be used in your hydrology calculation directly.

**Rainfall Intensity Lookup Table**

The method allows you to enter the rainfall intensities of various durations for any of 2-year, 5-year, 10-year, 25-year, 50-year and 100-year return periods and creates a rainfall intensity lookup table. The rainfall intensity will be interpolated linearly from the table.
Users in Kentucky have started using rainfall data from NOAA Atlas 14 volume 2 and require project specific rainfall information. The rainfall data can be obtained here: http://hdsc.nws.noaa.gov/hdsc/pfds/orb/ky_pfds.html. After selecting the data type and the location, the precipitation frequency estimate table from NOAA Atlas 14 would be shown as follows. You can then enter the data by either the Rainfall Accumulation method or Rainfall Intensity method into Carlson. You are not require to enter all the data, three durations of rainfall data is enough for creating the IDF curves for each return period.

### Point Precipitation Frequency Estimates From NOAA Atlas 14

<table>
<thead>
<tr>
<th>ARI (Years)</th>
<th>5 min</th>
<th>10 min</th>
<th>15 min</th>
<th>20 min</th>
<th>30 min</th>
<th>60 min</th>
<th>120 min</th>
<th>3 hr</th>
<th>6 hr</th>
<th>12 hr</th>
<th>24 hr</th>
<th>48 hr</th>
<th>72 hr</th>
<th>180 hr</th>
<th>1 day</th>
<th>10 day</th>
<th>20 day</th>
<th>30 day</th>
<th>45 day</th>
<th>60 day</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.24</td>
<td>0.54</td>
<td>0.72</td>
<td>1.15</td>
<td>1.36</td>
<td>1.98</td>
<td>2.16</td>
<td>2.67</td>
<td>3.23</td>
<td>3.70</td>
<td>4.48</td>
<td>5.13</td>
<td>7.06</td>
<td>8.76</td>
<td>11.06</td>
<td>11.35</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.42</td>
<td>0.63</td>
<td>0.93</td>
<td>1.38</td>
<td>1.63</td>
<td>2.12</td>
<td>2.37</td>
<td>3.18</td>
<td>3.94</td>
<td>4.60</td>
<td>5.27</td>
<td>6.08</td>
<td>8.36</td>
<td>10.36</td>
<td>13.03</td>
<td>15.69</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0.46</td>
<td>0.74</td>
<td>1.10</td>
<td>1.70</td>
<td>1.99</td>
<td>2.59</td>
<td>3.12</td>
<td>3.54</td>
<td>4.63</td>
<td>5.56</td>
<td>6.31</td>
<td>7.19</td>
<td>9.83</td>
<td>12.07</td>
<td>14.95</td>
<td>17.38</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>0.51</td>
<td>0.82</td>
<td>1.20</td>
<td>2.16</td>
<td>2.46</td>
<td>3.37</td>
<td>3.75</td>
<td>4.37</td>
<td>5.26</td>
<td>5.92</td>
<td>7.12</td>
<td>7.05</td>
<td>10.60</td>
<td>13.30</td>
<td>16.30</td>
<td>19.42</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>0.58</td>
<td>0.92</td>
<td>1.57</td>
<td>2.71</td>
<td>3.01</td>
<td>3.95</td>
<td>4.75</td>
<td>5.59</td>
<td>6.69</td>
<td>7.47</td>
<td>9.07</td>
<td>9.55</td>
<td>13.14</td>
<td>15.90</td>
<td>19.07</td>
<td>22.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>0.63</td>
<td>1.01</td>
<td>1.92</td>
<td>3.06</td>
<td>3.38</td>
<td>4.25</td>
<td>5.05</td>
<td>5.96</td>
<td>7.09</td>
<td>8.14</td>
<td>9.93</td>
<td>10.26</td>
<td>14.06</td>
<td>16.92</td>
<td>20.11</td>
<td>23.63</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>0.66</td>
<td>1.09</td>
<td>2.10</td>
<td>2.90</td>
<td>3.43</td>
<td>3.97</td>
<td>4.43</td>
<td>5.31</td>
<td>6.30</td>
<td>7.48</td>
<td>9.14</td>
<td>9.53</td>
<td>13.14</td>
<td>15.90</td>
<td>19.07</td>
<td>22.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>0.74</td>
<td>1.17</td>
<td>1.47</td>
<td>2.39</td>
<td>2.82</td>
<td>3.22</td>
<td>3.90</td>
<td>5.09</td>
<td>5.91</td>
<td>6.92</td>
<td>8.80</td>
<td>9.28</td>
<td>13.14</td>
<td>15.90</td>
<td>19.07</td>
<td>22.50</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>500</td>
<td>0.83</td>
<td>1.27</td>
<td>1.60</td>
<td>2.56</td>
<td>3.67</td>
<td>4.37</td>
<td>4.95</td>
<td>5.67</td>
<td>6.76</td>
<td>7.79</td>
<td>9.68</td>
<td>10.15</td>
<td>14.06</td>
<td>16.92</td>
<td>20.11</td>
<td>23.63</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>0.86</td>
<td>1.36</td>
<td>1.70</td>
<td>2.76</td>
<td>4.02</td>
<td>4.83</td>
<td>5.16</td>
<td>5.26</td>
<td>7.45</td>
<td>8.47</td>
<td>10.35</td>
<td>12.05</td>
<td>16.00</td>
<td>19.00</td>
<td>22.93</td>
<td>26.64</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Default Libraries**

A default library is included in the install and placed in the Carlson Projects\Settings folder. This library is for Ohio and includes 4 IDF curves for different regions. Use the Load function to select this library. There are also many default libraries for North Carolina under Carlson Projects\Settings\NorthCarolina.

**Pulldown Menu Location:** Network > Sewer Network Libraries > Rainfall Library  
**Keyboard Command:** rainlib  
**Prerequisite:** None
**Inlet Library**

In storm sewer systems, inlets are the surface components that gather the ground runoff and convey the flow to a subsurface storm sewer network. The inlet capacities should be sufficient to intercept the flows that the sewer system can handle. Inlets can be located "on-grade" or in sag locations. Inlets located "on-grade" may be designed to intercept either all or part of the runoff in the gutter whereas inlets that are installed in sag points should be sized to capture the entire runoff approaching them. The longitudinal and cross-slope of the roadway along with the Manning's 'n' value of the gutter influence the performance of the inlet. These parameters can be obtained automatically in the watershed modeling of the sewer network design. The details of the inlet design procedures can be found in the HEC-22 Manual.

The Inlet Library command allows you to make, edit and store inlets. The working Inlet library data file is stored (by default) in the %AppData%\Carlson Software\...\User\Inlet.dta file and is available across all Carlson Software projects.

The Custom Properties function defines additional fields for each inlet. Values for these fields can be entered into the Inlet Library. Then these fields are available in the Report Sewer Network command.

![Inlet Library dialog box](image)

When you create or edit an inlet, the New/Edit Inlet dialog box displays (shown below).

**Inlet ID:** Indicate the name of the inlet.

**Inlet Type:** Indicate the type of inlet:
- Grate
- Curb
- Slotted
- Combo (Grate/Curb)
- Ditch

**Profile:** Indicate whether the inlet is located in a sag portion of a vertical curve or "on grade."

**Gutter Parameters:** A gutter is a section of pavement adjacent to the roadway, which conveys flow during a storm runoff event. Gutters can have uniform and composite sections. A uniform gutter has the same cross-slope value as the cross-slope of the roadway adjacent to the gutter. A composite gutter section is depressed in relation to the adjacent pavement cross-slope. Therefore, the Gutter Depression should be entered when using a Composite gutter. The Local Depression is the depression for curb inlets that are off the gutter section.

**Design Inlet Length:** When enabled, the inlet length is calculated based on Design Constraints of the maximum allowable ponding width (spread) on the roadway and the interception efficiency. When disabled, the spread and
efficiency are computed. When the inlet is at a sag location, the interception efficiency is always 100%.

**Symbol Name:** Click on Symbol button to select a symbol for displaying the inlet in the plan view on the screen.

When either the Grate or Combo inlet type is specified, the controls on the Grate Inlet tab are enabled allowing you to create or edit the Grate details. Grate inlets perform well on grades where clogging with debris is not a problem. Their capacity decreases as the pavement longitudinal slope increases. Grate inlets are not generally recommended for use in sag locations because of their tendency to clog. There are seven types of standardized grates: P-1-7/8 (P-50), P-1-1/8 (P-30), 45d Tilt Bar, Reticuline, P-1-7/8-4 (P-50x100), Curved Vane, 30d Tilt Bar

Please refer to HEC-22 for additional details. You can also define your own type of grate by selecting **Other** in the Grate Type list. If you use a non-standard grate on grade, you must specify a splash-over velocity. Enter the grate dimensions in the Grate Length and Grate Width boxes. When a grate inlet is used, its width can't exceed the Gutter Width.

If the grate inlet is in a sag location, sag-related parameters need to be specified. A grate inlet in a sag operates as a weir at small ponding depths and like an orifice at large depths and these are dependent on the size of the grate. The Clogging Ratio is the percent area of the inlet covered by debris whereas the Opening Ratio is the ratio of the open area to the total area, which can be obtained from HEC-22. You need to specify the Opening Ratio if you use a non-standard grate.
When either the Curb or Combo inlet type is specified, the controls on the Curb Inlet tab are enabled allowing you to create or edit the curb inlet. Curb inlets are less inclined to clog than are grate inlets and have little interference on traffic operation. When placed "on grade," their interception capacity decreases more significantly than that of Grate Inlets as the pavement longitudinal slope increases. As such, Curb Inlets are suitable for use in sag locations or on relatively flat roadways.

When the Curb Inlet is located in a sag, you need to specify the Throat Type:

- Horizontal
- Inclined
- Vertical

Please refer to HEC-22 for details on throat types. Additional parameters including the Opening Height, Weir and Orifice Coefficients must also be specified. A curb inlet in a sag behaves as a weir when the depth of water ponding at the curb is less than or equal to the height of the curb opening and like an orifice when ponding depth is greater than 1.4 times the height.
When a Slotted inlet type is specified, the controls on the Slotted Inlet tab are enabled allowing you create or edit a Slotted inlet. Slotted inlets are very effective in intercepting sheet flows due to their long lengths and are suitable to place on roadways. They are very sensitive to clogging and therefore not recommended for use in sags and other locations where debris loadings are considerable. When the slot width is at least 1.75 inches (45 mm) and placed on the pavement along the length of the gutter, the slotted inlet operates similarly to a Curb Inlet.

When installed in a sag, Slotted Inlets perform as weirs to depths up to 0.2 ft (0.06m) and like orifices when the depth is greater than 0.4 ft (0.12m). Refer to HEC-22 for more information.
When the Combo inlet type is specified, the controls on the Grate Inlet tab and Curb Inlet tab are enabled and offer the advantages of both inlet types. The grate is usually the same length as the curb opening and placed alongside it; also called an Equal Length inlet. When the curb opening is longer than the grate, it effectively intercepts trash and debris which may clog the grate and is otherwise known as a Sweeper Inlet.

When a Ditch inlet type is specified, the controls on the Ditch Inlet tab are enabled allowing you create or edit a Ditch inlet. Ditch inlets are typically placed only in sag locations making their capture efficiency 100%. Care should be taken when utilizing Ditch inlets such that the opening does not create a dangerous traffic hazard. In addition to specifying the Bottom Width of the Ditch Inlet, also specify the Left and Right Side ratios as an H:1 ratio.

The Calculation tab allows you to determine how the active inlet will perform against the following parameters:

**Flow to Inlet:** Specify an assumed amount of flow that will be traveling to the inlet.

**Longitudinal Slope:** Specify the slope that leads into the inlet.

**Pavement Cross Slope:** Specify the slope of the pavement that abuts the inlet.

**Manning’s n:** Indicate the Manning’s n value for the pavement that abuts the inlet or click the Library to retrieve the Manning’s n value from the Pavement Manning’s n Library.

**Intercepted Flow:** The amount of flow that is intercepted by the inlet is reported.

**Bypass Flow:** The amount of flow (if any) that by-passes the inlet is reported.

**Gutter Spread:** The gutter spread (distance from the curb to the outermost edge of the flow of water) is reported.

**Water Depth:** The water depth in the gutter is reported.
Pavement Manning's n Library

The working Pavement Manning’s n library data file is stored (by default) in the `%AppData%\Carlson Software\...\User\Paven.dta` file and is available across all Carlson Software projects. Selecting a desired pavement value and clicking the OK button returns the selected *Manning’s n* value back to the Calculation tab.

Clicking the New or Edit button allows a new pavement type and it’s corresponding *Manning’s n* value to be specified.

**Pavement Manning's n New Entry**

**Type of Pavement:** Indicate the desired type of pavement.

**Manning's n Value:** Indicate the *Manning’s n* value associated with the pavement type.
Pulldown Menu Location(s): Network > Sewer Network Libraries  
Keyboard Command: inletlib  
Prerequisite: None

**Sewer Structure Library**

The Sewer Structure Library command allows you to create, edit and store sewer structures. The details of the design and construction of sewer structures can be found in the HEC-22 manual.

The working structure data file is stored (by default) in the `%AppData%\Carlson Software\...\User\SwrStruct.dta` file and is available across all Carlson Software projects. Existing structures can be edited, sorted or removed from the Structure Library and the Library itself can be saved or re-loaded as desired. The Copy function makes a new structure with the dimensions copied from an existing structure.

The Custom Properties function defines additional fields for each structure. Values for these fields can be entered into the Structure Library. Then these fields are available in the Report Sewer Network command.

Clicking New gives you the ability to create one of the four types of sewer structures allowed in the Carlson Hydrology module:

- Outfalls are outlet structures at the sewer outlet location. A regular outfall may consist of a headwall and two wingwalls while a funnel outfall consists of a funnel shape structure.
• Box Structures are usually used to support inlet openings and connect them to the underground piping system.
• Circular Structures are manholes that provide access to the sewer network for inspection and maintenance. Manholes are usually installed where pipes change direction (horizontally, vertically or slope), where two or more pipes join or where the pipe sizes change.
• Headwall Inlets are an open-end section similar to a culvert entrance and is used to capture flows at low points.
• Lateral Connections used for sewer network connection to network mains.

• Lateral Cleanouts used for connections to Laterals, typically to provide individuals (residential or businesses a location to connect to public utilities).

For each structure type, a Draw option allows you to place a "profile aspect" detailed image of the structure (complete with annotation) into your drawing.

In the Structure ID box, type the structure name. For the regular outfalls, enter the dimensions of the headwall and wingwalls. For the funnel type outfalls, enable the Use Funnel Symbol toggle and enter the length and widths of the funnel.

In the Box Structure dialog, type the name of the structure in the Structure ID box, enter the length and width of the structure.
In addition to specifying the physical dimensions of the box structure, you also have the ability to indicate one or more "offset locations" that may better position the box structure around the pipes in situations where the roadway direction is skewed relative to the orientation of the pipes:

Consider the following example showing a Box Structure with custom offset:
"X" offsets can vary between -1 (Left) through 1 (Right) as a decimal factor relative to the structure length. "Y" offsets can vary between -1 (Back) through 1 (Front) as a decimal factor relative to the structure width.

In the Structure ID box, type the structure name. Select a Taper Format and enter the Bottom Diameter, Top Diameter, Taper Offset and Taper Height of the structure. A graphic box on the right side of the dialog displays the graphic of the currently defined manhole.

The headwall inlet is very similar to the outfall structure of headwall type. In the Structure ID box, type the structure name. Enter the dimensions of the headwall and wingwalls. Inlet loss coefficient is used in hydrograph routing calculation.

Type the Structure ID. Enter the Invert Offset at the main. Add Custom Properties if required.

Type the Structure ID. Enter the cleanout pipe diameter. Add Custom Properties if required.
Pipe Size Library

The Pipe Size Library command allows you to store the dimensions of the widely used pipes. There are four pipe sections: box, circular, horizontal ellipse and vertical ellipse. The working structure data file is stored (by default) in the \%AppData\% \Carlson Software\...\User\PipeSize.dta file and is available across all Carlson Software projects.

From the Network > Sewer Network Libraries menu in the Hydrology Module, select Pipe Size Library to open the library dialog. The Section Type list contains four section types. You can select one pipe shape to display all the pipe sizes of that shape in the spreadsheet. In the right column of the spreadsheet, the Available in Design check boxes are listed next to the pipe sizes indicating that whether the pipe sizes are available in the pipe size design or not. You may choose to display the Min/Max Cover, Min/Max Slope, Min/Max Velocity and Cradle Data on the spreadsheet. These parameters are used in sewer network design and analysis.

The Custom Properties function defines additional fields for each pipe. Values for these fields can be entered into the Pipe Size Library. Then these fields are available in the Report Sewer Network command.

New button adds a new pipe size, Edit button allows you to modify an existing pipe size, and Delete button removes the highlighted pipe size from the library. Load and SaveAs buttons allow you to load and save the pipe size data.

In the Circular Section dialog, type the value in the Diameter box, and then the full cross-section area is calculated and displayed. You may fill in the Design Constraints and Cradle Info for sewer network analysis and sewer profiles. Click on OK button to commit the pipe size entry.
In the Box Section dialog, type the values in the Height and Width boxes, and then the full cross-section area is calculated and displayed. You may fill in the Design Constraints and Cradle Info for sewer network analysis and sewer profiles. Click on OK button to commit the pipe size entry.

In the Horizontal and Vertical Ellipse Section dialog, type the values in the Rise, Span and Full Area boxes. The Equivalent Diameter is the diameter of a circular section that is equivalent to the ellipse. The Flow Area Factor is the ratio of the calculated full area to the specified full area. A0, A1, A2, A3 and A4 are the five coefficients to the 4th order polynomial equation, which describes the relationship between the wetted perimeter (in) of the ellipse and
the depth/rise ratio, as below.

\[ p = A_0 + A_1 \frac{d}{r} + A_2 \left(\frac{d}{r}\right)^2 + A_3 \left(\frac{d}{r}\right)^3 + A_4 \left(\frac{d}{r}\right)^4, \]

where:

- \( p \) = wetted perimeter (in or mm)
- \( d \) = water depth in the pipe (ft or m)
- \( r \) = pipe rise (ft or m)

**Default Libraries**

There are several default libraries for North Carolina under Carlson Projects\Settings\NorthCarolina. Use the Load function to select a library.

**Pulldown Menu Location:** Network > Sewer Network Libraries > Pipe Size Library  
**Keyboard Command:** pszlib  
**Prerequisite:** None

**Pipe Manning's N Library**

The Pipe Manning's n Library command allows you to store commonly used pipe types and their Manning's n values. The working pipe Manning's n data file is stored (by default) in the %AppData%\Carlson Software\User\Pipen.dta file and is available across all Carlson Software projects for both culvert design and sewer network design.

The Custom Properties function defines additional fields for each pipe material. Values for these fields can be entered into the Pipe Material Library. Then these fields are available in the Report Sewer Network command.

The New button creates a new pipe Manning's n entry while the Edit button allows you to modify the highlighted entry while the Delete button removes the highlighted pipe entry from the library. The Load and SaveAs buttons allow you to load and save the library data.
Pipe Material Name: Indicate the desired pipe material name.

Material Type: Select the closest available pipe material.

Manning's n Value: Indicate the appropriate Manning's n value for the pipe.

---

Pulldown Menu Location(s): Network > Sewer Network Libraries

Keyboard Command: pipenlib

Prerequisite: None

Pavement Manning's N Library

The Pavement Manning's N Library command allows you to store commonly used pavement types and their Manning's n values. The library file is in the ...\USER folder and is available for all projects.

From the Network > Sewer Network Libraries menu in the Hydrology Module, select Pavement Manning's N Library to open the library dialog. The Type of Pavements of Gutter list displays all the stored pavement types and the Manning's N list displays the corresponding Manning's n values. New button creates a new pavement Manning's n entry, Edit button allows you to modify the highlighted entry, and Delete button removes the highlighted entry from the library. Load and SaveAs buttons allow you to load and save the library data.
Prompts

**Pavement Manning's N Library dialog:** Fill in values.

**Pull down Menu Location:** Network > Sewer Network Libraries > Pavement Manning's N Library

**Keyboard Command:** pavenlib

**Prerequisite:** None

---

**Curve Number Library**

The Curve Number Library command allows you to store commonly used drainage area cover descriptions, soil types and their curve numbers for SCS method. The library file is in the ...\USER folder and is available for all projects in sewer network design.

From the Network > Sewer Network Libraries menu in the Hydrology Module, select Curve Number Library to open the library dialog. The Cover Description list displays all the stored drainage area cover types, the A, B, C and D lists display the curve numbers for soil type A, B, C and D. New button creates a new curve number entry, Edit button allows you to modify the highlighted entry, and Delete button removes the highlighted entry from the library. Load and SaveAs buttons allow you to load and save the library data.
Drainage Runoff Library

The Drainage Runoff Library command allows you to store commonly used drainage area types and their runoff coefficients. The library file is in the ...\USER folder and is available for all projects in sewer network design.

From the Network > Sewer Network Libraries menu in the Hydrology Module, select Drainage Runoff Library to open the library dialog. The Type of Drainage Area list displays all the stored drainage area types and the Runoff Coefficient list displays the corresponding runoff coefficients. New button creates a new drainage runoff entry, Edit button allows you to modify the highlighted entry, and Delete button removes the highlighted entry from the library. Load and SaveAs buttons allow you to load and save the library data.

Prompts

Curve Number Library dialog: Fill in values.

Pulldown Menu Location: Network > Sewer Network Libraries > Curve Number Library

Keyboard Command: cnlib

Prerequisite: None

Drainage Runoff Library
Default Libraries
There are several default libraries for North Carolina under Carlson Projects\Settings\NorthCarolina. Use the Load function to select a library

Prompts

Drainage Runoff Library dialog: Fill in values.

Pulldown Menu Location: Network > Sewer Network Libraries > Drainage Runoff Library
Keyboard Command: runofflib
Prerequisite: None

Edit Sewer Structure
The Create Sewer Structure or Edit Sewer Structure command is a very powerful program for the design and analysis of networks. A storm sewer network is generally made up of pipes, structures and inlets. A sanitary/utility network, unlike a storm sewer, doesn't have inlets. There may be more than one pipe entering a structure, but only one can exit. The network type is specified via the Sewer Network Settings command. Depending on the type of sewer network being created or edited, you'll either have the full-featured editing control (described below) for Storm Sewer networks or a more stream-lined Create/Edit Sanitary/Utility Structure command.
This command allows you to construct a graphical representation of a pipe network in the active drawing with associated data including (but not limited to) pipe, structure, inlet, watershed and rainfall details. The Edit/Create Sewer Structure command takes the form of a "docked dialog box" as illustrated below. This flexible interface allows direct access to the Command, graphic window, pull-down menus and toolbars... all while the docked dialog box is open.

The storm sewer network is solved using the standard step gradually varied flow methods. This is an iterative procedure used to determine the energy and hydraulic terms at the end of each pipe. The direction of computation is from the most downstream pipe of the network to the most upstream pipe. The following steady state energy equation is used between the upstream and downstream ends of every pipe. Please refer to HEC-22 manual for details. You can design the sewer system with one rainfall return period, and analyze it with another return period.

\[
Z_u + \frac{V_u^2}{2g} = Z_d + \frac{V_d^2}{2g} + H_f
\]

where: 
- \(Z_u\) = upstream water surface elevation 
- \(V_u^2 / 2g\) = upstream velocity head 
- \(Z_d\) = downstream water surface elevation 
- \(V_d^2 / 2g\) = downstream velocity head 
- \(H_f\) = friction loss

The Manning's equation is applied to determine the friction slope.

\[
Q = \frac{(M/n) A R^{2/3}}{S_f^{1/2}}
\]

where: 
- \(Q\) = discharge 
- \(M = 1.49\) for English unit, \(1.0\) for Metric units 
- \(n\) = Manning's roughness coefficient 
- \(A\) = cross-sectional area 
- \(R\) = hydraulic radius 
- \(S_f\) = friction slope

Then the friction loss along the pipe is computed by the following equation:
\[ H_f = S_f L \]

where: \( L \) = pipe length

With the friction loss calculated, the elevation of the upstream water surface can be determined.

First set up the working environment by running command Sewer Network Settings under Network → Sewer Network Setup menu. Then select Edit/Create Sewer Structure. If you are creating a sewer structure, pick a location in the plan view where you want to locate the structure, otherwise click on an existing structure symbol. After a structure has been located, the dock dialog displays, and the current structure symbol is highlighted in the drawing. Following is an example of the dock dialog.

This dialog window has four tabs:

1. **Structure** - Controls information related to sewer structures (manholes, inlets, rim elevation, etc).
2. **Drainage** - Controls drainage information including watershed information.
3. **Pipe** - Controls information related to sewer pipes (connection points, size, material, etc).
4. **Hydraulic Calc** - Controls and reports information related to junction losses and the hydraulic calculations.

Other common controls include:

**Settings**: This function performs as same as the Sewer Network Settings command except for the settings found on the General tab.

**Design**: This function sets the sewer network in design mode. After laying out a sewer network, this function designs the profile of sewer lines, such as pipe inverts and sizes, depending on the design settings, and then performs the hydraulic calculation.

When designing pipe sizes, the program first estimates the design flow for each pipe in the system and makes an initial selection of the size required for each pipe.

Typically, pipe slope is set to the actual invert slope. If the pipe invert elevations are to be designed, pipe slope is assumed as the same as the normal slope. The Manning equation is then used to solve the required pipe size given the pipe Manning's \( n \) coefficient, design discharge and slope. The calculated size is then rounded up to an available size in the pipe size library. When designing pipe invert elevations, the criterion of minimizing ground cover at all locations along pipe lines is used.
After initial design, the program analyzes gradually varied flow with the standard step method for a few iterations. It uses the actual velocity from the previous calculation to determine the actual flow and hydraulic grade line, modifies the pipe sizes and invert elevations based on the design constraints, and then performs next iteration of computation, until the result is stable and meets the design constraints. Any violations of the design settings will be displayed in a warning message dialog window.

**Analyze:** This function sets the sewer network to analysis mode and conducts a hydraulic calculation on the existing sewer network.

The program analyzes gradually varied flow with the standard step method and reports the results such as hydraulic grade line, energy grade line, flow velocity, drainage flow rate and inlet interception, etc. Any violations of the design settings will be displayed in a warning message dialog window.

**Apply Pipe Rules:** Click this button to correct detected pipe problems against those specified in the Pipe Size Library. Use standard Windows **click, shift+click** and/or **ctrl+click** functionality to select multiple pipes at the same time.

![Image](image-url)

**Add:** This function allows you to create a new structure and will connect the structure to the nearest structure found in the specified **System Name** control located on the Structure tab.

**Edit:** This function allows you to pick an existing structure symbol in the plan view to make the structure active for editing.

**Remove:** This function removes the structure that you pick and also removes the corresponding pipes and then reconstructs the network.

**Apply:** Commits any changes to the sewer network.

**Up:** Moves to the upstream structure and makes it active.

**Down:** Moves to the downstream structure and makes it active.

**Close:** Prompts to save any pending network changes and dismisses the docked dialog box.
Structure Name: Provide a unique value to identify the structure in the network.

System Name: A name for current network. All the structures within a sewer network must have the same System Name (there can be more than one sewer network in a sewer (.SEW) file.

Description: Provide an optional note that further describes the structure.

Inlet: Select a pre-defined inlet to be associated with the structure or click the Library button to select an Inlet or make changes to the Inlet Library. In addition to associating an Inlet with the Structure, the Library button also populates the Symbol Name control with the default value stored in the Inlet Library.

Structure ID: Select a pre-defined structure or click the Library button to select a Structure or make changes to the Structure Library.

Reference CL: Use the Select button to determine the station and offset location of the structure relative to a Centerline File or polyline in the drawing.

Northing, Easting: Use the Location button to identify the coordinate location where the Structure should be located.

Inlet Offset: Specify the placement of the inlet relative to that of the structure or click the Setup button for common offset configurations:
X-Offset: Specify the Easting/Departure of the inlet relative to that of the structure.

Y-Offset: Specify the Northing/Latitude of the inlet relative to that of the structure.

Pick Inlet Location: Graphically identify the placement of the inlet relative to that of the structure.

Symbol Name: Use the Symbol button to select a symbol for the Structure or to over-ride the value associated with the current Inlet.

Symbol Rotate: Indicate the method to orient the Symbol Name in the drawing. If a Reference CL has been specified and depending on how the symbol was originally drawn, consider using one of the Parallel to CL... or Perp to CL... options to orient the symbol relative to the direction of the centerline.

Symbol Angle: When the Symbol Rotate value is set to Enter Azimuth Angle, use this field to specify the rotation angle for the symbol.

Symbol Size: Indicate how the size of the symbol should be determined:

- Inlet Library Width - The symbol is sized according to the Width specified in the Inlet Library.
- Drawing Scaler - The symbol block is scaled based on the Drawing Scaler derived in Drawing Setup.
- Unit Symbol - The symbol is sized based on the size of the symbol block itself.

Rim Elevation: Indicate the rim elevation for the structure.

Depth: Indicate the distance between the Rim Elevation and the base (bottom) elevation of the structure.

Invert-Out Elev: Indicate the invert elevation of the pipe that exits the structure.

Invert-In Elev: Indicate the invert elevation of the pipe that enters the structure.

Drop Across MH: Indicate the amount of vertical drop across the manhole/structure.

Sump Height: Indicate the distance between the base elevation and the Invert-Out Elevation.

Surcharge Depth: The distance between the hydraulic grade line and the Rim Elevation. If the value is negative, the hydraulic grade line is below the rim elevation; otherwise, the water has blown out the structure.

Current Structure: The Structure Name from the Structure tab that is current. Use the Up, Down or Edit buttons to navigate through the network to set an alternate structure current.
Input Type: If the Computation Method option located in the Drainage tab of the Sewer Network Settings is set to Peak Discharge, then this option is disabled. If the Computation Method is set to Hydrograph, two input types are available:

- Drainage Data - will let the program generate runoff hydrograph, or,
- Hydrograph - specify a known runoff hydrograph directly.

Area Units: Choose a unit to display the area values.

Draw: When this button is clicked, a watershed analysis is performed on the surface model and the drainage area that contributes to this inlet is hatched in the drawing.

Drainage Area: The drainage area that contributes to this inlet only.

Pick: Use this button to select a closed polyline that represents the boundary of the drainage area. The area will be calculated and displayed.

Calc: This function triggers the watershed analysis routine to calculate the drainage area and displays the value.

Time to Inlet: Indicate the time to inlet or click on the Set button to calculate the Time of Concentration based on the Rational Method.

Runoff Coeff: Indicate the runoff coefficient or click the Select button to derive a weighted runoff coefficient from land uses and their respective areas. Please refer to the documentation on Define Runoff Layers for details.

Pond/Swamp Adjust: When the Hydro Methods option located in the Drainage tab of the Sewer Network Settings is set to SCS, indicate the Pond and swamp adjustment factor used in SCS peak flow calculations.

Known Flow: You may elect to let any known flow enter into the downstream pipe directly or go through the inlet by enabling the Thru Inlet toggle. This provides flexibility to input the calculated drainage runoff directly to the program and to also enter known sanitary flow, infiltration/exfiltration flow, etc, into the sewer network.

Thru Inlet: When enabled, this option signifies that the Known Flow will be entering the sewer network through the inlet rather than simply being considered in-situ flow.

In Hydrograph: When the Input Type is set to Hydrograph, use the Select button to specify the Runoff Hydrograph file name (.HYD) that enters into the structure.

Long Slope: Enter the longitudinal slope of the pavement. This edit field is only available if the inlet is "on-grade."

Cross Slope: Enter the pavement cross slope.

Calc: This function triggers the watershed analysis routine to analyze the surface model and extract the longitudinal slope and cross slope.

Manning's n: Indicate the Manning's n-value for the pavement or click on the Library button to retrieve this value from the Pavement Manning's n Library.

Next Inlet for Bypass: Indicate the inlet that shall receive any by-pass flow.

Flow Calculation: After you issue either the Design or the Analyze command on the network, the inlet calculation results are displayed. The inlet results help you to determine if the inlet is sufficient for conveying the ground flow into the network.
Pipe Name: Provide a unique value to identify the pipe in the network.

Downstream (Upstream) Connections: A list showing the connection that exits the structure or the connection(s) that enter the structure, depending on the Direction setting found on the Design tab of the Sewer Network Settings.

Available: A list that contains all of the structures that are not connected to the current structure, i.e. the potential structures that can be connected to the current structure.

Add: Select an available structure to connect to the current structure and click on the Add button to form the connection.

Pick: Select a structure symbol in the plan view graphic to form a connection between it and the current structure. If the connection cannot be completed, a warning message appears.

Remove: Highlight a connection in the Downstream (Upstream) Connections list and click on the Remove button to remove the connecting pipe between the structures.

Pipe Material: Select the pipe material or click on the Library button to select a pipe and its corresponding Manning’s n value from the Pipe Manning’s n Library.

Manning’s n: Indicate the Manning’s n coefficient is used to calculate the friction loss of the pipe.

Pipe Shape: The pipes can have four different cross-sectional shapes:

- Circular
- Box
- Horizontal Ellipse
- Vertical Ellipse

Refer to the Pipe Size Library for additional details.

Pipe Size: If the Auto Set All Sewer Pipe Sizes option found on the Design tab of the Sewer Network Settings dialog box is disabled, select the desired pipe size from the list of available pipe sizes or click on the Library button to access the Pipe Size Library.

Design: When enabled, the program calculates an appropriate pipe size based on the flow and design settings and selects the closest available pipe size from the Pipe Size Library.
Pipe CL: This option allows you to design a curvilinear (non-straight) pipe. The pipe centerline should start from one structure and end at the other structure exactly. Use the Select button to identify a Centerline File or polyline in the drawing that represents the pipe path.

Down Invert/Up Invert: If the Auto Set All the Invert Elevations of the Sewer Network option found on the Design tab of the Sewer Network Settings dialog box is disabled, indicate the upstream and/or downstream invert elevation of the current pipe or enable either Design toggle to have the program calculate the design invert elevation(s).

Slope: If neither the Up Invert Design toggle nor the Down Invert Design toggle is enabled, indicate the pipe slope. Changing the Slope value will alter the Up Invert value unless the Hold Upstream toggle is enabled.

Step Up: Indicate the "step up" amount of the Down Invert elevation with respect to the "invert out" elevation of the structure to which it connects.

# of Barrels: Indicate the number of pipe barrels that can be found between the Upstream and Downstream structures.

Hori. Spacing: Indicate the amount of horizontal spacing between each of the Barrels.

After you issue either the Design or the Analyze command on the network, the pipe calculation results are shown.

Pipe Flow: Flow that is being carried by the pipe:

- Full Flow: Flow that is being carried by the pipe when flowing full.
- Max Flow: The maximum flow that can be carried by the pipe.

Total Area: Total of all the drainage areas that contribute to the flow inside the pipe.

Length: The length of the pipe based on the Pipe Length setting found on the Display tab of the Sewer Network Settings.

Min. Cover: The minimum distance from the surface elevation to the crown elevation along the length of the pipe.

Travel Time: How long the flow travels through the pipe.

Out Hydrograph: When the computation method is hydrograph, you are able to generate the outflow hydrograph at the outlet of each pipe. Use the Select button to specify the file name.

Pipe Profile: Click on this button to launch the Spreadsheet Sewer Editor command.

The energy losses through a pipe junction are specified in the Hydraulic Calc tab. There are four methods to calculate the junction losses: Approximate Method, Dynamic Method, Fixed Head Loss and Energy-Loss Method.

Junction Losses: Indicate one of the following methods for junction loss consideration:

- Approximate Method - uses the difference between the downstream velocity head and the upstream velocity head multiplied by the junction Loss Coefficient.
- Dynamic Method - uses the downstream velocity head multiplied by the junction Loss Coefficient.
- Fixed Head Loss - uses the actual Head Loss you specify.
- HEC22 Energy-Loss Method - similar to the Dynamic Method, uses the downstream velocity head multiplied by the adjusted junction loss coefficient. The adjusted junction loss coefficient is defined as the initial head loss coefficient based on relative size of structure multiplied by the correction factors for pipe diameter, flow depth, relative flow, plunging flow and benching. Please refer to the HEC-22 manual for details.
- Total Loss Method - uses uniform pipe velocities to compute the contraction loss, expansion loss and the greatest bend loss and sums them to get the total head loss. If surface inflow into the structure is greater than 20% of the total flow, then the total head loss should be increased by 30%.
- Total Loss Smoothed Method (Inlet Shaping) - is similar to Total Loss Method. The difference is that the total head loss should be decreased by 50% if the manhole or junction incorporates partial diameter inlet shaping or channel smoothing.

After you issue either the Design or the Analyze command on the network, the hydraulic calculation results are displayed. The hydraulic grade line, energy grade line, flow depth and flow velocity at both downstream and upstream ends are reported. A graphic box also shows the hydraulic and energy grade lines, pipe outlines and the ground surface, which help you to observe the design result easily.
Prompts

Select sewer structure to edit: Pick a manhole symbol.

Pulldown Menu Location(s): Network
Keyboard Command: editswr or putswr
Prerequisite: A sewer (.SEW) file

Edit/Create Sanitary/Utility Structure

This is an alternative version of Edit/Create Sewer Structure for the design of sanitary and utility networks. A sanitary or utility network is generally made up of pipes and structures. There may be more than one pipe entering a structure, but only one can exit. The network type is set in the Sewer Network Settings dialog, and the default type is storm sewer. When you run Edit/Create Sewer Structure, the program performs differently based on the network type. If you work on a storm sewer network, please refer to the documentation on the Edit/Create Sewer Structure.

This command construct a graphical representation of a pipe network in active drawing, which contains all your design data, such as pipe and structure data. The following is an network example. The Edit/Create Sanitary/Utility Structure dock dialog is on the left, while the network plan view in the active drawing is on the right with current structure and pipe highlighted. When you modify the edit fields on the dock dialog and click on Apply button, the network plan view will be updated automatically. Furthermore, you are allowed to work on the active drawing while the dock dialog is open. This command doesn’t perform hydrology calculation, so no flow data is needed.
1. Dock-Dialog Components

First set up the working environment by running command Sewer Network Settings under Network > Sewer Network Setup menu. Then select Edit/Create Sewer Structure. If you are creating a sewer structure, pick a location in the plan view where you want to locate the structure, otherwise click on an existing structure symbol. After a structure has been located, the dock dialog displays, and the current structure symbol is highlighted in the drawing. Following is an example of the dock dialog.

Edit/Create Sanitary/Utility Structure Dialog and Dynamic Editing in the Active Design Drawing

Chapter 7. Hydrology Module
This dialog window has two tabs, Structure and Pipe, which are used to enter structure and pipe parameters. The following is the description of the functionalities of the buttons for designing sanitary/utility network.

**Settings:** This function performs as same as the Sewer Network Settings command except for the generate settings of setting up the network file and surface file etc. Please refer to the documentation on Sewer Network Settings.

**Add:** Adds a new structure to the network at the location you pick in the plan view. The just created structure will become the active structure for editing.

**Edit:** This function allows you to pick an existing structure symbol in the plan view to make the structure active for editing.

**Remove:** This function removes the structure that you pick, and also removes the corresponding pipes and then reconstruct the network.

**Apply:** Save the changes of the network.

**Up:** Moves to the upstream structure and makes it active.

**Down:** Moves to the downstream structure and makes it active.

**Close:** Quit the sewer network dock dialog.

### 2. Structure

The structure data is entered through the Structure tab.

<table>
<thead>
<tr>
<th>Structure</th>
<th>Pipe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure Name</td>
<td>M2</td>
</tr>
<tr>
<td>System Name</td>
<td>A</td>
</tr>
<tr>
<td>Structure ID</td>
<td>Box1</td>
</tr>
<tr>
<td>Reference CL</td>
<td></td>
</tr>
<tr>
<td>Northing, Easting</td>
<td>1012.488, 1072.840</td>
</tr>
<tr>
<td>Symbol Name</td>
<td>INLET4</td>
</tr>
<tr>
<td>Symbol Rotate</td>
<td>Parallel to CL Up</td>
</tr>
<tr>
<td>Symbol Angle</td>
<td>0.0000</td>
</tr>
<tr>
<td>Symbol Size</td>
<td>Drawing Scale</td>
</tr>
<tr>
<td>Rim Elevation</td>
<td>365.925</td>
</tr>
<tr>
<td>Depth</td>
<td>5.1325</td>
</tr>
<tr>
<td>Invert-Out Elev</td>
<td>360.7700</td>
</tr>
<tr>
<td>Sump Height</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

Sanitary/Utility Network Edit Structure

**Structure Name:** An identical name of the structure in the network.

**System Name:** A name for current network. All the structures in the same network have the same system name.

**Structure ID:** This is the ID of a predefined structure in the structure library. The Library button next to it allows you to select or define a sewer structure in the structure library. Once you select the structure, the dimension of the structure are retrieved from the library. Please refer to the documentation of the Sewer Structure Library for details.
**Reference CL**: The reference centerline is used to locate the structure by station/offset of the centerline points, and align the structure symbol in the graphic. The **Select** button allows you to select a centerline from either a centerline file or a polyline.

**Location**: This button allows to relocate the structure by pick a position in the drawing.

**Symbol Name**: This is the name of the symbol that represents the structure in the network plan view. The **Symbol** button allows you to select a symbol from a list of symbols.

**Symbol Rotate**: There are 10 options to rotate the structure symbol for displaying in the drawing.

**Symbol Angle**: When the Symbol Rotate value is set to Enter Azimuth Angle, this edit field is enabled for entering an angle.

**Symbol Size**: Three options to determine the size of the structure symbol.

**Rim Elevation**: The rim elevation for the structure, it's usually the surface elevation.

**Depth**: The distance between the rim elevation and the base elevation of the structure.

**Invert-Out Elev**: The invert elevation of the pipe that exits the structure.

**Sump Height**: The distance between the base elevation and the invert-out elevation.

### 3. Pipe

The pipe data is entered through the pipe tab. The **Downstream/Upstream** list contains the connection that exits the structure or the connections that enter the structure, depending on the design direction. The **Available** list contains all the structures that are not connected to the current structure, i.e. the potential structures that can be connected to the current structure. There is two ways to add a connection. The first one is clicking on the **Add** button to connect the highlighted structure in the Available list to the current structure. The other one is clicking on the **Pick** button and then select a structure symbol in the plan view to connect it. If the connection is unable to be performed, a warning massage pops up. The **Remove** button allows you to remove the highlighted connection from the Downstream/Upstream list.
Pipe Name: An identical name of the pipe in the network.

Pipe Shape: The pipes can have four different cross-sectional shapes: circular, box, horizontal ellipse and vertical ellipse.

**Pipe Material:** There are nine material options.

**Pipe Size:** The value can be chosen from a list of pipe sizes stored in the size library.

**Pipe Size Library:** This button allows you to store commonly used pipe sizes. Please refer to the documentation on the Pipe Size Library for details.

**Pipe CL:** This option allows you to design a non-straight pipe. The pipe centerline should start from one structure and end at the other exactly. If you change the location of one of the structures, the centerline would be deserted and the pipe would become straight.

**Manning’s n:** The Manning’s n coefficient is used to calculate the friction loss of the pipe. The **Library** button allows you to select a Manning’s n value. Please refer to the documentation on the Manning’s N Library for details.

**Down Invert/Up Invert:** They are the downstream invert and upstream invert elevations of the pipe.

**Slope:** Pipe slope.

Min. Cover: The minimum distance from the surface elevation to the crown elevation all along the pipe, is calculated automatically.

The lateral data is entered through the Add Button. Toggle the Add Lateral From Cleanout Point. A Lateral cleanout can ONLY be an upstream connection.

```
Pick Point:
Select location on screen.
Select a pipe to insert lateral connection.

Point Number:
Enter structure point number.
Select a pipe to insert lateral connection.

Station Offset of CL: Enter Structure Station (note requires structure to be assigned to a CL file).
Enter Structure Offset (note positive numbers for right offset, and negative numbers for left. For Example 25,-25).
```
Select a pipe to insert lateral connection.

Distance and Direction: Enter distance
Code: 1-NE 2-SE 3-SW 4-NW 5-AZ
Enter direction code (1-5) <1> (default)
Enter bearing (dd.mmss):
Select a pipe to insert lateral connection

Cancel: Cancel Locate Structure.

**Prompts**

*Select sewer structure to edit:* pick a manhole symbol
*Sewer Structure Data dialog:* Fill in values

**Pulldown Menu Location:** network > Edit/Create Sewer Structure
**Keyboard Command:** editswr/putswr
**Prerequisite:** a sewer file (.SEW), a surface file (.TIN, .GRD, .FLT)

**Remove Sewer Structure**

This command removes a structure from the sewer network. The structure to remove can be selected from a list of structure names or screen picked. To screen select a manhole, pick on the manhole symbol. The manhole symbol and labels are erased from the screen and the manhole is removed from the sewer network file.

**Prompts**

*Select structures to erase by screen pick or name list [<Pick>/List]?* press Enter for Pick
*Select sewer structure to remove:* pick a manhole symbol
*Select sewer structure to remove:* press Enter to end

**Pulldown Menu Location:** Network
**Keyboard Command:** rmswr
**Prerequisite:** Sewer network manholes
Check Sewer Network Parameters

This command reads a sewer network file and audits the sewer network for any invalid data fields or values that don't follow the specified design constraints. If any problems are found with the sewer data, a report is displayed indicating all invalid values.

Pulldown Menu Location(s): Network → Check Sewer Network

Keyboard Command: chkswr

Prerequisite: A sewer file (.SEW) and corresponding Inlet Data and Pipe Size Data.

Check Reference Centerlines and Surface

This command is a manual alternative to the Auto linking method found on the General tab of the Sewer Network Settings. This routine compares the sewer network structure locations to that of the reference surface and centerline(s). The current sewer surface file is used as the elevation reference for the structure rim elevations.

Each structure has the option to assign a reference centerline and the structure will record the station and offset from this centerline. If this routine finds a difference between the structure location and the referenced centerline, an option will be provided to either update the sewer structures to their new and relative station/offset or simply leave the structures where they are located.

For reference surface changes, the structure rim elevation can be updated and there are two options for updating the invert elevation. One method is to hold the structure depth and change the invert elevation. The other method is to hold the invert elevation and change the depth.

Pulldown Menu Location(s): Network → Check Sewer Network

Keyboard Command: chkswrref

Prerequisite: Sewer (.SEW) file

Collision Conflicts Check

When there are two or more sewer networks in one area, it's very important to know if there are any collisions among pipe lines. The Collision Conflicts Check command performs a three dimensional check on sewer networks. If any portions of the two systems are too close to each other, i.e their distance is closer than the safety buffer, the conflicting pipes and their collision locations would be reported. The program also checks for any collisions within the same sewer network. Besides checking sewer networks, the Check Pipe 3D Polylines option will check for collisions with 3D polylines that have been tagged as pipes with the Assign Pipe Data To Polyline command.

From the Network > Check Sewer Network menu in the Hydrology Module, select Collision Conflicts Check. In the dialog, select two or more network files that you want to check the collisions and/or turn on the Check Pipe 3D Polylines toggle. In the Conflict Tolerance box, specify the value of the distance buffer that any two of the sewer systems shouldn't violate. The Use Collision Navigator toggle provides an Data Problem Log dialog to navigate you to the locations of every collision, otherwise the collisions would reported in Carlson standard report format. Choose the Report Crossing Pipes options would include the details of each pipe crossing in the standard report. Draw Collision Symbols option would draw a symbol at each collision.
Sewer Network Collision Conflict Check

Data Problem Log dialog

When the Use Collision Navigator toggle is on, an Data Problem Log is generated if the Collision Conflicts Check finds any collisions. Clicking to the "+" sign beside the Collisions Total will display the individual collisions. When a collision item is selected, click on Zoom To button and the drawing is centered to the exact location of the highlighted collision. Zoom In button zooms in on the highlighted collision for a closer inspection. Zoom Out zooms out away from the collision. Report All/One toggles between One and All depending on whether a single collision or all collisions are selected from the Log. An error Report is generated listing the positions of the entities in conflict.
Collision Navigator

Collision Example
Collision Report Example

Prompts

Collision Conflicts Check dialog: Fill in values.

Pulldown Menu Location: Network > Check Sewer Network > Collision Conflicts Check
Keyboard Command: chkmswr
Prerequisite: two to four sewer files (.SEW)

Find Sewer Structure

This command will find a sewer structure by name.

Prompts

Structure Name to Find: A3

The program will then display a temporary arrow locating the structure, and zoom to it at the current zoom resolution.

Pulldown Menu Location: Network
Keyboard Command: findswr
**Prerequisite:** Sewer network (.SEW) file

---

**Report Sewer Network**

This command reads a sewer network file and reports its design parameters and hydraulic results. Select Report Sewer Network from the Network menu in the Hydrology Module, the report dialog displays. The Select Sewer Line(s) To Report list displays all upstream entrance structure names, which represents pipe lines from every entrance to the outfall. Select one entrance to report one pipe line. If you want to report the whole sewer network, turn on the Report All Sewer Lines toggle.

The sewer network report has four categories: inlet, pipe, structure and drainage, in order to report all information thoroughly. Simple Report lists some portion of information from all four categories, and Custom Report allows you to choose which portion of data you would like to report from the combination of drainage and pipe categories. Report HGL Computation lists the result of the friction losses of every pipe and the junction losses of every structure. Report Water Surface Elevation for Sag Inlets lists the orifice and weir calculation of the sag inlets. Report Lateral lists the data for lateral connections.

Turn on the Use Report Formatter toggle will report the sewer network data in a Microsoft Excel spreadsheet, otherwise in the standard Carlson report window from where the information can be edited, printed to a printer or to the screen, and saved.

---

![Sewer Network Report](image)

**Sewer Network Report**
Prompts

Report Sewer Network dialog: Fill in values.

Pulldown Menu Location: Network > Report Sewer Network

Keyboard Command: reportswr

Prerequisite: a sewer file (.SEW), a surface file (.TIN, .GRD)...\USER\RainLib.dta, ...\USER\inlet.dta, ...
\USER\pipesize.dta (mpipesize.dta in Metric unit), ...\USER\swrStruct.dta

Sewer Network Inspector

The command allows you to inspect the active sewer network on screen.

Select Sewer Network Inspector from Network menu. Move your cursor to the sewer network in plan view. When the cursor hovers over a structure or a pipe, its parameters will be shown on screen. After finishing inspection, press Enter key to exit.
Prompts

Pulldown Menu Location: Network > Sewer Network Inspector
Keyboard Command: swinspect
Prerequisite: active sewer network in plan view
Sewer Network Hydrographs

This command generates the runoff hydrograph for every catch basin, inflow hydrograph for every pipe at upstream and outflow hydrograph for every pipe at downstream. If the sewer network uses Rational method to calculate the peak flow, the runoff hydrograph is calculated by Universal Rational method; otherwise, the runoff hydrograph is calculated by SCS method. The storage-indication method is used to route the inflow hydrograph through the whole network.

Select Sewer Network Hydrographs from the Network menu in the Hydrology Module. The command reads the current active sewer network file and conducts the hydraulic computation. If the computation is successful, a dialog opens with the lists of inflow and outflow hydrographs identified by the structures and pipes. Select a runoff, inflow and outflow hydrograph and click on Display button to show the hydrographs in the Hydrograph dialog.

Prompts

Sewer Network Hydrographs dialog: Fill in values.

Pulldown Menu Location: Network > Sewer Network Hydrographs

Keyboard Command: swrhyd

Prerequisite: a sewer file (.SEW), a surface file (.TIN, .GRD), \USER\RainLib.dta, \USER\inlet.dta, \USER\pipesize.dta (mpipesize.dta in Metric unit), \USER\swrStruct.dta, \USER\paven.dta, \USER\pipen.dta, \USER\runoff.dta

Spreadsheet Sewer Editor

This command is an alternative method to the Edit Sewer Structure command for editing existing sewer networks in a tabular format. Data changes can be applied more quickly in the spreadsheet editor and the content and position of displayed data is customizable.
Sewer Editor without Laterals

Sewer Editor with Laterals

Show Lateral Lines: Select Lateral Main Pipe Line

Select Pipe Line: Select the sewer reach that will be displayed in the dialog box or enable the Select All Pipe Lines

Chapter 7. Hydrology Module
toggle to display the entire sewer network.

**Show Whole Pipe Line:** When enabled, the entire sewer network reach of the selected pipe is displayed.

**Vertical Exag:** Indicate the desired amount of vertical exaggeration to be applied to the selected pipe display.

**Edit Multiple Pipes:** To globally change the value within a given column to a specific value, "click and drag" or use standard Windows **shift+click** functionality to select a range of cells within a given column and then click *Edit Multiple Pipes*.

**Sort Spreadsheet by Structure Names:** Enable this option if you would like to order the sewer network alphabetically by the structure names. When disabled, the data is sorted by connection order from downstream to upstream.

**Pipe at Junction Match By:** Indicate the method by which pipes are vertically aligned at each junction:

- **Inverts:** Sets the pipe inverts at the same elevation at a given junction.
- **Crowns:** Sets the pipe crowns at the same elevation at a given junction.
- **None:** No vertical adjustment is performed.

**Pipe Profile Edit Actions:** Indicate what should happen when *Hydro Calc* is clicked:

**Hold Pipe Slope:** Indicate how to manipulate the slope of the identified pipe(s):

- **Current Slope:** The slope of the current pipe is held.
- **Min Slope:** The minimum pipe slope is held.
- **None:** No vertical adjustment is performed.

**Edit Actions:** Set the desired method of how the sewer network should be adjusted when the *Hydro Calc* button is clicked.

**Spreadsheet Display Settings:** Enable the options for the value(s) you would like displayed in the Sewer Spreadsheet Editor and position each them using the Move Up and Move Down buttons.

![Spreadsheet Settings](image)

**Pipe Length:** Indicate the method that should determine the length of pipe; center of structure to center of structure or inside edge of structure to inside edge of structure.

**Pipe Slope:** Indicate the method that should determine the slope of the pipe; center of structure to center of structure or inside edge of structure to inside edge of structure.

**Display Slope In:** Indicate the unit of measure to be used for the display of the pipe slope.

**Hydro Calc:** The hydraulic calculations are performed on the network and the results are displayed.

**Results:** This option allows data or graphical reports of the network to be generated.
Report Output: Indicate the desired type of report output:

- **Custom Report Formatter**: Produces a user-customized report format using the standard Carlson Report Formatter functionality.
- **Graphic with Spreadsheet Data**: Produces a PDF-based report of the sewer network (see an example below) along with data results in a tabular format.

**Draw Network Profile, Draw Surface Profile, Draw Hydraulic Grade Line, Draw Energy Grade Line**: When enabled, the appropriate item is included in the graphical portion of the report and allows the Linetype and Color to be specified for each, respectively.

**Draw Profile for Each Pipe Separately**: When enabled, each pipe is detailed into the report as illustrated above.
When disabled, each reach of the sewer network is drawn into the report.

**Page Setup:** Allows the look and size of the eventual PDF report to be customized using the standard Carlson PDF Report Generator.

**Pulldown Menu Location(s):** Network

**Keyboard Command:** sizeswr

**Prerequisite:** A sewer (.SEW) file, a surface (.TIN, .GRD, .FLT) file

---

**Draw Sewer Network Plan View**

This command draws and labels the manhole symbols and pipe connections for the current sewer network (.SEW) file. An arrow can be drawn on the connections to indicate the direction of flow. The format for the labels is defined in the Plan View Label Settings command.

![Example drawn sewer network](image)

**Pulldown Menu Location:** Network

**Keyboard Command:** drawswr

**Prerequisite:** Sewer network (.SEW) file

---

**Draw Sewer Network Data Table**

This command draws the sewer network structure and pipe data tables on screen.

Select Data Table from Network > Draw Sewer Network menu. In the Table Settings dialog, specify the table name that will be shown as the table title, the layer name, the text style and the text size. Choose the table type, either the sewer structures or sewer pipes, and also the direction how you want to display the sewer network: downstream to upstream or upstream to downstream. Click on Set Table Columns button to open a spreadsheet dialog, from where you can specify how you want to display the data table: which fields to display and in what order, the label, width, alignment and precision of each field. Choose Use Table Entity option to draw the data tables as the table entities, otherwise the tables are drawn as the traditional table block. After entering all parameters, click on OK button to draw the data table.
Column Settings Dialog for Sewer Pipe Tables

Sewer Structure Data Table Example

Sewer Pipe Data Table Example

Prompts

Sewer Network Table Settings dialog: Fill in values

Pulldown Menu Location: Network > Draw Sewer Network > Data Table

Keyboard Command: swrtbl

Prerequisite: a sewer network file

Draw Sewer Network Centerlines

This command creates a centerline that connects each pipeline between the selected structures. The centerline can be drawn as a polyline or saved to a centerline (.cl) file. The direction of the centerline can go either upstream or downstream.

Pulldown Menu Location: Network

Keyboard Command: drswrcl
Prerequisite: Sewer network (.SEW) file

Draw Sewer Network Profile
This command will read the active sewer network (.SEW) file, which contains inverts elevations, rim elevations, pipe sizes and structure dimensions, and draw the network as a profile, using the standard prompting in Draw Profile. In the options dialog, you can select the structure names for the start and end of the profile and set the profile direction as either upstream or downstream. The Save To Profile File option will save the sewer profile to a .pro file in addition to drawing the profile. When the Save option is active, there is a option available to Link Profiles To Sewer Network. This Link option will update the sewer profile drawing whenever the sewer network is modified. Also, this link option will update the sewer network if the profile is changed. For example, if Input-Edit Profile is used to change an invert elevation and the link option is active, then the invert elevation will also be updated in the sewer network. If you have a road and want to use it to reference the sewer network, you can choose the Station by Another Reference Centerline to do that. When not using a reference centerline, the Starting Station value is used for the beginning station of the sewer profile. Draw Pipe Lateral Connections will draw ellipses at the profile structures for any additional pipes that connect to the structure. Label Flow Along Pipes option pulls out the total flow that runs through each pipe and labels it on the profile. Draw Hydraulic and Energy Grade Line option records the hydraulic flow calculation result and draw hydraulic and energy grade lines with network profile. You may choose to draw HGL/EGL for multiple storm events. The Draw Existing Ground Surface and Draw Design Surface options will prompt for a surface file and then extract a profile from the surface to draw with the network profile. If you have other profiles to draw along with the network as a reference, such as a road profile, turn on the Prompt for Additional Profiles to Draw option. Extend Network Centerline lengthens the sewer network centerline by the specified amounts for extracting the surface profile for the existing and design surfaces.

Consider the Sewer Trunk Line shown in the plan view below:
When this network main sewer line is entered using Locate Sewer Structure, starting at the upstream rim elevation of 1369.73 and running downhill to 1328.54, a new .SEW file is created. Prompting asks you to select a starting structure. If you created 5 structures named A1 through A5, you could choose A1 to plot all 5. This file will then plot, in profile view, as shown below (this example was drawn without ground surface or hydraulic grade lines). If you pick Draw Existing Ground Surface, you will be prompted for the grid or triangulation file for the ground surface, and similarly if you turn on Draw Design Surface.

Prompts

**Draw Sewer Network Profile dialog:** Fill in values

**Pulldown Menu Location:** Network->Draw Sewer Network

**Keyboard Command:** drswrpro

**Prerequisite:** Sewer network (.SEW) file
Draw Sewer Network-3DFaces

The command will read the active sewer file as set through the Set Sewer File command and draws the sewer pipelines as 3D faces for viewing in 3D. A primary use for this routine is to perform visual checks to help verify if there are sufficient clearances with other 3D objects.

The 3D faces are drawn directly on the plan view in a layer of your choosing. The structures are drawn using the dimensions as defined in the Sewer Structure Library.

3D Face Layer: Key-in or use the Select button to identify the target layer for the 3D Face entities.

Pulldown Menu Location(s): Network → Draw Sewer Network

Keyboard Command: swr3d

Prerequisite: Sewer network (.SEW) file

Move Sewer Label

This command moves the selected plan view sewer network labels with the option to draw a leader from the labels to the sewer network reference location. Both structure and pipe labels can be moved. The purpose is to clean up label overlaps. To move a label, pick any one of the text labels and the program will pick up all the other associated labels. Then pick the new location and while the pointer is moved, the program shows an outline of the label area. The program remembers the moved locations for each label so that when the plan view labels are redrawn, the moved locations are retained.
At the command prompt, there are keyboard options to show command Options, change the Angle and to Restore. The Options function brings up a dialog for command options for when to draw the label leader and whether to include an arrow head. The Minimum Leader Length Scaler value is multiplied by the current Horizontal Scale defined in Drawing Setup to set the minimum distance from the label to the structure for a leader to be drawn. The Angle function allows you to rotate the label. The Restore function puts the labels back to their default position.

For pipe labels, there is an extra option at the command line when picking the new location to make the label horizontal. Otherwise the pipe label is aligned with the pipe segment.

These graphics show the sewer labels before and after Move Sewer Label was used to clean up the label overlaps.

**Prompts**

**Select sewer label to move [Options/Angle/Restore]:** Pick a sewer label text entity  
**Pick label position:** pick a point  
**Select sewer label to move or Enter to end [Options/Angle/Restore]:** press Enter to end

**Pulldown Menu Location:** Network  
**Keyboard Command:** move_swrlabel  
**Prerequisite:** Plan view sewer network labels
Pipe Elevation Label

The command labels pipe elevations in plan view at specified points. In the options dialog, there are options whether to label the pipe invert elevation and pipe crown elevation. Also, there are options for the label prefix, suffix, layer, size, style, color, decimal places and whether to draw a leader from the label to the pipe. The Pick Label Location option allows for manually picking the location for the label. Otherwise, the label is automatically placed next to the pipe position. After clicking OK from the options dialog, the program prompts for points to label. For each point, the program finds the closest perpendicular point along a pipe in the current sewer network and labels that pipe position.

The elevation labels are for the inside pipe elevations without using the pipe wall thickness. A reason for labeling the pipe elevations is for checking for collisions.

![Image of Label Setup dialog]

Prompts

Pick pipe location (Enter to end): *pick a point*
Pick pipe location (Enter to end): *press Enter*

Pulldown Menu Location: Network > Sewer Labels
Keyboard Command: swrlabpipe
Prerequisite: sewer network in plan view
**Draw IDF Curve**

This command plots the Intensity-Duration-Frequency curves for the rainfall associated with the current sewer network. From the Network menu in the Hydrology Module, choose Draw IDF Curve. On the top of the dialog, the sewer network file name and the rainfall ID are shown. The Library button allows you to specify other rainfall data from the rainfall library. In the Return Period list, select one or more return periods. Select the Display Duration in either Hour or Minute, and enter the values in the Duration and Duration Interval boxes. Click on OK button to plot. The Draw IDF Settings dialog allows you to specify how to plot IDF curves on screen.

![Draw IDF Curves](image)

![Draw IDF Settings](image)
IDF Curve Example

Prompts

Draw IDF Curve dialog: Fill in values.
Pulldown Menu Location: Network > Draw IDF Curve
Keyboard Command: drwidf
Prerequisite: a sewer file (.SEW), ...

Find And Replace Data Values

The Edit Sewer Structure command allows you to modify the parameters of a sewer network. However, it can be tedious when the network is large and when you need to change just one parameter of most of the sewer structures or pipe lines. For example, you'll have to go through all pipe lines if you want to change pipe manning's n to 0.014 for all pipes whose manning's n is currently 0.013. Here, the Find and Replace Data Values command would help you to find and replace the pipe manning's n values for all pipes at once.

From the Network > Sewer Network Utilities menu in the Hydrology Module, select Find and Replace Data Values to open the dialog. The sewer file name is displayed on the top of the dialog. In the Parameters list, choose what parameter you want to replace. In the Find what Box, type the value that you want to change, and in the Replace with box type the new value. Click on Replace button to find all pipes with manning's n values of 0.013 and replace their manning's n with 0.014. A message will be displayed on the dialog showing how many values have been replaced. Click on OK button to commit the changes or Cancel button to abandon the changes.
Prompts

**Find and Replace Data Values dialog:** Fill in values.

**Pulldown Menu Location:** Network > Sewer Network Utilities > Find and Replace Data Values

**Keyboard Command:** swr_find_replace

**Prerequisite:** a sewer file (.SEW)

Renumber Structure Names

The Renumber Structure Names routine provides an easy method to quickly rename/renumber all or part of a sewer network. Once a sewer file has been specified or set as Active via the Set Sewer File command, the following dialog box is presented.

**Sewer Network File:** The active sewer file that will be acted upon.

**Highest Structure Name:** The ID of the structure with the largest numerical value.

**Selection Method:** Indicate the method of which structures should be renumbered. *Range* allows the structures to be identified via the dialog box; *Selection Set* allows the structures to be identified via a graphical selection method.

**Range to Process:** When the *Selection Method* is set to *Range*, manually identify the structure(s) that should be part of the renumber process or click on the *All* button to select all structures in the network.

**Renumbering Method:** Indicate how structures should be renumbered. *Begin From* assigns the *Starting Name* value to the lowest structure name and increments by one until the network has been renumbered; *Increment By* adds the *Increment* value to each structure.

**Note:**
• Caution should be exercised when specifying a negative value for the **Increment** setting as duplicate structure numbers may result if the Increment value forces the renumbered structures to values less than 0.

• For network structures that do not contain a numerical value (*e.g.* MHA, MHB, MHC, MHD, *etc.*), a trailing numerical value of 1 is assumed (*e.g.* MHA1, MHB1, MHC1, MHD1, *etc.*) before the Increment process commences.

**Pulldown Menu Location(s):** Network → Sewer Network Utilities  
**Keyboard Command:** renumswr  
**Prerequisite:** A sewer (.SEW) file

### Set Rim Elevation to Match Surface

This command compares the rim elevations for the current sewer network with the current surface model. If any differences are found, the program shows a dialog box with the rim elevations, surface elevations, structure names and elevation differences. You can highlight structures from this list to update their rim elevations to match the surface model. There are two update methods:

- **Update Depth, Hold Invert:** Keeps the invert elevations while updating the rim elevations so that the depths are adjusted.
- **Update Invert, Hold Depth:** Adjusts the invert elevations by the same amount as the rim elevations so that the depths are maintained.

![Sewer Network Reset Rim Elevation](image)

**Pulldown Menu Location:** Network->Sewer Network Utilities  
**Keyboard Command:** swrsurf  
**Prerequisite:** sewer network structures

### Edit/Create Structure With Inverts

The Create Structure With Inverts command creates structures with rim and invert elevations but without pipe connections. So these structures are standalone without connections and can't be used for hydraulic calculations. The main purpose for these structures is for plan view labeling. The labels are controlled by the Plan View Label Settings command.

After picking the location for the structure, the data for the structure is entered in the dialog shown here. You can have any number of inverts that can be entered by either elevation or depth in the spreadsheet. See the Create Sewer Structure command in the manual for details on the other fields in this dialog.
The Edit Structure With Inverts command allows you to modify the data in existing structures. To run this command, first pick on a structure symbol or label and then the dialog shown here is used to edit the data.

**Pulldown Menu Location:** Network->Sewer Network Utilities  
**Keyboard Command:** putswrstr, editswrstr  
**Prerequisite:** None

### Review Sewer Network Links

This command shows a list of all the sewer network links that the program knows about in the current drawing. These links are between the sewer network files and the drawing entities. You can use the Remove button to remove links for any obsolete sewer networks or if you don't want to link a certain sewer network.

**Pulldown Menu Location:** Network->Sewer Network Utilities  
**Keyboard Command:** swrnetdict  
**Prerequisite:** Sewer network (.SEW) file

### Review Sewer Profile Links

This command shows a list of all the sewer network profile links that the program knows about in the current drawing. These links are between the sewer network files and the sewer profiles in the drawing. You can use the Remove button to remove links for any obsolete sewer profiles or if you don't want to link a certain sewer profile.

**Pulldown Menu Location:** Network->Sewer Network Utilities  
**Keyboard Command:** swrprodict  
**Prerequisite:** none
Import Carlson Sewer Network

In certain scenarios, it may be desirable to combine the contents of one Carlson sewer project file into another sewer file and form a more comprehensive Carlson sewer project file. The Import Carlson Sewer Network routine will import selected contents of a Carlson sewer file (.sew) into the active sewer file as defined via the Set Sewer File command or the Sewer Network Settings command. If an active sewer file has not been set, you will first be prompted to select an active sewer network file and will then continue with the command as described below.

Browse to the folder location where the Carlson sewer file resides that you wish to import into the current sewer file.

Use standard Windows click, shift+click and/or ctrl+click functionality to select the structure(s) that should be imported.

Note:

- Any structure names found in the incoming sewer file that are also found in the active sewer file will not be imported.
- After being imported, the network can be drawn into the drawing via the Draw Sewer Plan command.

Pulldown Menu Location: Network > Sewer Network Utilities
Keyboard Command: impswr
Prerequisite: Existing Carlson Software sewer file (*.sew)
Import Network From 3D Polylines

This function assigns pre-determined sewer parameters for pipes and structures from selected 3D polylines that have been previously drawn to the screen and converts them to a Sewer (*.SEW) file. This command is very similar to the Import Sewer Network from 2D Polylines command and the Import Network from Centerline/Profile command. Sewer structures are inserted at the polyline vertices with the base elevation of the structure taken from the polyline vertex elevation. Pipes are created to replace the polyline segments and the invert elevations of the pipes also come from the polyline vertex elevations.

System Name: Indicate the system designation for the incoming sewer entities. A *.SEW file can have multiple systems (e.g. A, B, STRM1, STRM2, etc) within it.

Starting Structure Name: Indicate the designation that is to be assigned to the first structure (i.e. a junction) to be created by the routine.

Starting Pipe Name: Indicate the designation that is to be assigned to the first pipe that will be created by the routine.

Default Rim Elevation to Surface Elevation: When enabled, this option allows you to click the Select File button to indicate a valid Carlson surface file (generally created through the Triangulate & Contour command) as the source for the new rim elevations.

Rim Elevation: Indicate a single desired rim elevation to be applied to all new structure locations.

Structure ID: Indicate the type of structure to be used for the new sewer data or click on the Library button to access the Sewer Structure Library command to create a new structure definition or edit an existing structure definition.

Inlet ID: Indicate the type of inlet to be used for the new sewer data or click on the Library button to access the Inlet Library command to create a new inlet definition or edit an existing inlet definition.

Pipe Material: Indicate the type of material to be used for the new pipes or click on the Library button to access the Pipe Material and Manning's n-Library command to create a new pipe material or edit an existing pipe material definition.

Pipe Shape: Indicate the general pipe shape that is to be applied to the new pipes.
Pipe Size: Indicate the desired pipe size for the new pipes or click on the Library button to access the Pipe Size Library command to create a new pipe size or edit an existing pipe size definition.

Pipe Manning's n: Indicate the desired Manning's n-value to be applied to the new pipes.

Pavement Manning's n: Indicate the desired Manning's n-value to be applied for runoff considerations or click on the Library button to access the Pavement Manning's n-Library command to create a new Pavement Manning's n-value or edit an existing Pavement Manning's n-value definition.

Pavement Cross-slope: Indicate the desired pavement cross-slope for ponding width calculation purposes.

Pavement Longitudinal Slope: Indicate the desired pavement longitudinal slope for ponding width calculation purposes.

Prompts

Select 3D polylines.
Select objects: Select the desired 3D polylines that are to be converted and press Enter when complete. If several polylines are met at one vertex, only one structure is created, and the first polyline is the main flow line, others are the upstream branches.

The sewer network will be drawn on the screen as the routine completes and can be manually drawn later through the Draw Sewer Network > Plan View command.

Pulldown Menu Location(s): Network > Sewer Network Utilities
Keyboard Command: swr3dp
Prerequisite: 3D polylines drawn on screen

Import Sewer Network From 2D Polylines

This function assigns pre-determined sewer parameters for pipes and structures from selected 2D polylines that have been previously drawn to the screen, places the pipes at a pre-determined offset from the structure rim elevation and converts them to a Sewer (*.SEW) file. This command is very similar to the Import Sewer Network from 3D Polylines command and the Import Network from Centerline/Profile command. Sewer structures are inserted at the polyline vertices with the base elevation of the structure taken from the polyline vertex elevation. Pipes are created to replace the polyline segments and the invert elevations of the pipes also come from the polyline vertex elevations.
**System Name:** Indicate the system designation for the incoming sewer entities. A *.SEW file can have multiple systems (e.g. A, B, STRM1, STRM2, etc) within it.

**Starting Structure Name:** Indicate the designation that is to be assigned to the first structure (i.e. a junction) to be created by the routine.

**Starting Pipe Name:** Indicate the designation that is to be assigned to the first pipe that will be created by the routine.

**Default Rim Elevation to Surface Elevation:** When enabled, this option allows you to click the Select File button indicate a valid Carlson surface file (generally created through the Triangulate & Contour command) as the source for the new rim elevations.

**Add Points from Surface Model:** When enabled, this option inserts additional junction points along the 2D polyline where it crosses the triangulation legs of the surface model.

**Reduce Tolerance:** Identify the smallest tolerance to which new points should be added to the 2D polyline.

**Rim Elevation:** Indicate a single desired rim elevation to be applied to all new structure locations.

**Offset Invert from the Rim:** Indicate a vertical offset distance rim elevation for the placement of the pipe.

**Offset on Pipe:** Indicate a the location on the pipe to be used for the pipe offset:

- **Top** - The top of the pipe is placed at the vertical offset from the rim elevation.
- **Center** - The center of the pipe is placed at the vertical offset from the rim elevation.
- **Bottom** - The bottom of the pipe is placed at the vertical offset from the rim elevation.

**Structure ID:** Indicate the type of structure to be used for the new sewer data or click on the Library button to access the Sewer Structure Library command to create a new structure definition or edit an existing structure definition.

**Inlet ID:** Indicate the type of inlet to be used for the new sewer data or click on the Library button to access the Inlet Library command to create a new inlet definition or edit an existing inlet definition.

**Symbol Name:** Use the Select button to access the symbol selector of the Symbol Library command to access a desired symbol for the structure.
Pipe Material: Indicate the type of material to be used for the new pipes or click on the Library button to access the Pipe Material and Manning's $n$-Library command to create a new pipe material or edit an existing pipe material definition.

Pipe Shape: Indicate the general pipe shape that is to be applied to the new pipes.

Pipe Size: Indicate the desired pipe size for the new pipes or click on the Library button to access the Pipe Size Library command to create a new pipe size or edit an existing pipe size definition.

Pipe Manning's $n$: Indicate the desired Manning's $n$-value to be applied to the new pipes.

Pavement Manning's $n$: Indicate the desired Manning's $n$-value to be applied for runoff considerations or click on the Library button to access the Pavement Manning's $n$-Library command to create a new Pavement Manning's $n$-value or edit an existing Pavement Manning's $n$-value definition.

Pavement Cross-slope: Indicate the desired pavement cross-slope for ponding width calculation purposes.

Pavement Longitudinal Slope: Indicate the desired pavement longitudinal slope for ponding width calculation purposes.

Prompts

Select 2D polylines.
Select objects: Select the desired 2D polylines that are to be converted and press Enter when complete. If several polylines are met at one vertex, only one structure is created, and the first polyline is the main flow line, others are the upstream branches.

The sewer network will be drawn on the screen as the routine completes and can be manually drawn later through the Draw Sewer Network > Plan View command.

Pulldown Menu Location(s): Network > Sewer Network Utilities
Keyboard Command: swr2dp
Prerequisite: 2D polylines drawn on screen

Import Network from Centerline/Profile

The Import Network from Centerline/Profile command allows a sewer file (*.SEW) file to be created by combining the horizontal components of a centerline (*.CL) file with the vertical component of a sewer profile (*.PRO) file. The process to create the sewer file is as follows:

1. The stationing contained within the centerline file is processed into memory.
2. The stations within the sewer profile file are located along the path of the centerline to form the structure/junction locations.
3. The pipe information stored within the sewer profile file are placed linearly between the structure locations.

The resultant sewer file can be further edited with the Edit Sewer Structure command or the Spreadsheet Sewer Editor command.

Note:

- Any stations within the *.PRO file that occur after the last station in the *.CL file are not written into the *.SEW file.
- Once the *.SEW file has been created, you can activate it for editing via the Set Sewer File command and/or draw it graphically via the Draw Sewer Network > Plan View command.

Pulldown Menu Location(s): Network > Sewer Network Utilities
Keyboard Command: swrc1pro
Prerequisite: Centerline (*.CL) file, Sewer Profile (*.PRO) file
Import StormCAD Network
This routine converts StormCAD storm sewer network files into Carlson sewer (.sew) files. The StormCAD data is stored in MDB database files. The routine prompts for the Pipes Database to read and then the Storm Database to read. The pipes data is required for the structure data. The storm data is optional for the drainage data.

Pulldown Menu Location: Network->Sewer Network Utilities
Keyboard Command: swrimport
Prerequisite: StormCAD file

Export Carlson Sewer Network
In certain scenarios, it may be desirable to save all or parts of the active sewer file to an alternate sewer file name or location. The Export Carlson Sewer Network routine will export selected contents of the active Carlson sewer file (.sew) as defined via the Set Sewer File command or the Sewer Network Settings command and create a new sewer output file. If an active sewer file has not been set, you will first be prompted to select an active sewer network file and will then continue with the command as described below.

Use standard Windows click, shift+click and/or ctrl+click functionality to select the structure(s) that should be imported.

Browse to the folder location where would like to write the new Carlson sewer file and specify the new sewer file name.

Pulldown Menu Location: Network > Sewer Network Utilities
Keyboard Command: expswr
Prerequisite: Existing Carlson Software sewer file (*.sew)

Export To Points
This command creates points in the current coordinate file for the selected structures of the current sewer network. In the options dialog, you can select multiple structures from the list of structure names. You can create points at the structure locations and the pipe locations. For pipes, you can create points at the invert-in and invert-out connection points, at the pipe mid-points and at an interval along the pipe. The Offset Pipe Points option offsets horizontally perpendicular to the pipe. The elevation for the structure points can be either the rim elevation or the invert-out of the structures. The point numbers will be incremented from the specified Starting Point Number. The Use Name in Description option puts the structure name into the point description.
Pulldown Menu Location: Network->Sewer Network Utilities
Keyboard Command: swr2pts
Prerequisite: Sewer network (.SEW) file

Export To Profiles

This command creates a profile (.pro) from the current sewer network. The profile is created from the specified upstream structure through all the downstream connections to the end of the pipeline. The profile direction can be either upstream or downstream for the stations.

Pulldown Menu Location: Network->Sewer Network Utilities
Keyboard Command: swr2pro
Prerequisite: Sewer network (.SEW) file
The HydroCAD Menu is primarily designed for use with the HydroCAD Stormwater Modeling software, but can be used without it. Only two commands on the HydroCAD Menu are not found in other locations within other Carlson menus; HydroNet Explorer and HydroCAD. The HydroCAD command on the HydroCAD Menu simply provides a way to start HydroCAD. The HydroNet Explorer is a new "docked dialog" that opens on the left side of the drawing screen, and is used to create and edit four types of components of a hydrologic project; subcatchments, ponds, reaches, and links.

Documentation on the Define Watershed Layers and Watershed Analysis commands is under the Watershed Menu topics.

**HydroNet Explorer**

The HydroNet Explorer is a "docked dialog" that opens on the left side of the drawing screen, and is used to create and edit four types of components of a hydrologic project; subcatchments, ponds, reaches, and links.

The general idea for the use of the HydroNet Explorer is that you have already prepared a drawing for analysis.

This preparation would include:

Soils: The boundaries of the Hydrologic Soils Groups should be drawn on the drawing layer specified in the Watershed Layers dialog, with the A, B, C, or D labels on the layer specified for that. These areas do not have to be closed polylines, as long as the linework encloses each area that is part of the study.

Ground Covers: The various Ground Covers in the study area should be drawn as closed polylines on the layers specified in the Watershed Layers dialog. These do not need to be labeled.

Watersheds: The Watersheds (subcatchments) for the site should be drawn and labeled. It is best to do this with closed polylines, but it is not essential, as you can use an alternative method of picking within the area and having the software define it from drawing linework.

When you run the HydroNet Explorer command, you are prompted to create a new .HYN file or open an existing one. This is the file that stores all of the data about the components in the project.
Once the HydroNet Explorer is open, the first thing you should do is check the settings for the current project. Pick the icon with the tools on it. In the HydroNet Settings dialog, review the various tabs containing the settings for the different aspects of the project. On the General tab, set the surface to be used to provide the average slope for each subcatchment when using the Curve Number/Lag method.

On the Subcatchment tab, set the default starting number for subcatchments, the default method for Tc calculation, and also set whether Curve Numbers should be calculated in Carlson Hydrology (check the box) or in HydroCAD.
On the Pond, Reach and Link tabs, set the default starting number for each of these components.

On the Rainfall tab, if you want rainfall to be added to the calculations in Carlson Hydrology, set up the rainfall parameters here. If you want the rainfall data to be added in HydroCAD, you can ignore this tab. Detailed information about setting up Rainfall events in Carlson is under the Watershed section of the Carlson documentation. There is also an icon at the top of the HydroNet Explorer that you can use to import a Rainfall event from a HydroCAD project file.

On the Report tab, establish the type of report and the details of the report that you want for each of the 4 component types.

Pick OK.

You can now use the HydroNet Explorer to automatically analyze the drawing and add all subcatchments defined in the drawing. Pick the Update button, and check all of the options.

With the dialog set up as shown, when you pick OK, all subcatchments found on the specified layer are added to the
Explorer and exported to HydroCAD. The detailed data for each subcatchment can now be viewed and/or edited. Double click on any subcatchment to edit.

To add Subcatchments manually, pick on the Subcatchment item in the Explorer, and either right click and pick add from the submenu or pick the Add icon.

In the Subcatchment dialog, enter the Number for the Subcatchment. If you have the Subcatchment labeled in the drawing, make the Number match the label. Pick the Edit button next to the Area. In the Sub Areas dialog, pick the Select Subcatchment button. Carlson Hydrology searches for a subcatchment on the layer specified in the Watershed Layers dialog that has a label that matches on the specified layer that matches the Number. If it finds one, it highlights it and asks you to confirm that this is the Subcatchment you are meaning to use. If you pick Yes, the SubAreas are calculated from all of the additional data in the drawing. Pick OK. Back in the Subcatchment dialog, if you specified the CN/Lag method for Tc, the Average Slope of the Subcatchment has been calculated and displayed, and the longest polyline within the subcatchment on the specified layer as been selected and it's length displayed. Pick OK. The new Subcatchment is listed in the Explorer.

The procedure to add Ponds, Reaches, and Links is similar to Subcatchments, either right click and pick Add, or select the category heading and pick the Add button below. The detailed documentation on inputting data for these component types is found in the Watershed section of the Carlson Hydrology documentation.

Export to HydroCAD. If you are using HydroCAD in conjunction with Carlson Hydrology, once the elements of the study are added to the HydroNet Explorer, pick the Export to HydroCAD button to transfer the data to HydroCAD.

Any changes made in the drawing that affect any of the components of the study can be instantly updated and sent to HydroCAD with the Update button in the HydroNet Explorer. Also, each individual component can be updated alone with the update button within it's specific dialog box.

The components listed in the HydroNet Explorer can also be drawn into the drawing file with the Draw Layout in CAD button (paintbrush). Set the desired parameters in the HydroNet Draw dialog box.

<table>
<thead>
<tr>
<th>HydroNet Draw Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer Name</strong></td>
</tr>
<tr>
<td><strong>Line Type</strong></td>
</tr>
<tr>
<td><strong>Text Style</strong></td>
</tr>
<tr>
<td><strong>Draw Scale</strong></td>
</tr>
<tr>
<td><strong>Diagram Scale</strong></td>
</tr>
<tr>
<td><strong>Symbol Scale</strong></td>
</tr>
<tr>
<td><strong>Text Scale</strong></td>
</tr>
</tbody>
</table>
**Pulldown Menu Location:** HydroCAD  
**Keyboard Command:** hydronet2  
**Prerequisite:** Soils, soil labels, watersheds, watershed labels, a TIN, and Ground Covers, all on different layers for the different areas.
GIS Data Menu

The GIS Data menu shown below has commands for managing and reporting data attached to drawing entities.

Carlson GIS and Esri

In addition to exchanging data with Esri using SHP files, Carlson GIS supports Feature Data within a drawing that is compatible with Esri ArcGIS software. This data is stored in a format created by Esri known as Mapping Specifications for CAD, or MSC. Starting with ArcGIS 9.3.1, Esri creates a DWG with MSC data using the Export To CAD function in the ArcGIS Toolbox. You can select which features to export to the DWG. The DWG with MSC contains the geometry of the features, the feature attribute definitions and the attribute values. Essentially, the DWG with MSC is a complete geodatabase. In Carlson GIS, set the data format to Esri under GIS Settings and the GIS commands such as Input-Edit GIS Data will work with the Esri data. You can both add and edit GIS data in Esri format in the DWG. Then to bring the data into ArcGIS, choose the Add Data function in ArcGIS and pick the DWG file. With the MSC data format within the DWG, ArcGIS will recognize the features in the DWG instead of everything defaulting to generic CAD.

Several Carlson programs can create this data, such as LotNet, SewerNet, Mining Timing and Surface Mine Reserves. When lots, pipe networks or mining areas are drawn, there are new options to create Esri MSC in the process. When selected, the drawing can then be saved and loaded into ArcGIS as data, and the Features and Attributes created are available to ArcGIS. Here is where MSC is created from the Draw Lots command in Lot Manager.
Here is where it is specified to create MSC when plan view of a Sewer Network is drawn.

**GIS Database Settings**

This command sets the current GIS Features and GIS Data Format. The GIS Features file (.GIS) defines the GIS features and the attributes for each feature. This file is set by the Define GIS Features command.

The Data Format defines where the GIS data will be stored. For Single File Type Database, the data is stored in an external database in either SQLite format (.DB) or MicroSoft® Access (.MDB). The Esri MSC Data stores the GIS data within the drawing file in a format that both Carlson and Esri use. Starting with ArcGIS 9.3, Esri added support for MSC which makes the DWG file a type of geodatabase with the feature definitions, GIS data and geometry all stored in the file.
Prompts

**GIS Setting dialog** Click both file buttons and select new or existing files.

---

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** gis_config  
**Prerequisite:** None

---

**Define Template Database**

This command creates the Feature/Attribute data structure, or schema, for GIS functionality. The structure is stored in a special Carlson file with a (.GIS) file extension. A feature, such as a manhole, can have multiple attributes, such as Number of rungs, Type of material, Number of inlets, etc. Features can be organized into Categories: Utilities, Roads, Properties. The Category designation is an arbitrary way of organizing the features. Features and attributes can be imported from Field to Finish, Esri MSC data within the drawing, or from older Carlson Template Database MDB files.

Features and attributes can of course also be defined "from scratch" in the Define GIS Features dialog box.

1) The first field to set is the GIS file you are working with. Use the File menu to create a new (.GIS) file or open an existing one for editing.

2) Next, set up one or more Category Names, using the Category menu. GIS feature codes can be categorized (e.g. STRUCTURES, UTILITIES, ROAD FEATURES, etc.). At least one category must be created.

3) Next, define Features, using the Feature menu. e.g. A category such as UTILITIES might have features such as manholes, light poles, fire hydrants, water valves, etc.
4) Lastly, define the attributes for the Feature. Each attribute has:

a) a Name
b) a Full Name, or Prompt
c) a Type - Integer, Character or Real
d) a Default Value - these can be preset, or read from a list of automatically generated values using the Default button
e) optionally, a List of values to pick from. Use the List Values button to build a list
f) whether the attribute is required
g) whether the attribute Value can be field Edited, appears as Read Only, or is Hidden
h) whether the value used is restricted to the list
Geometry Settings

At the bottom of the dialog box the user can specify the geometry settings for each feature, whether it is a line or point feature, what layer it is to be drawn on, what block to use to represent it, what text style to use, and what linetype to use.

Pulldown Menu Location: GIS Data
Keyboard Command: def_template
Prerequisite: None

Input-Edit GIS Data

This routine creates, reviews and appends GIS data linked to entities stored in the drawing.

The GIS Smart Prompting dialog has a spreadsheet format for editing the data fields. The GIS table to process is selected in the pull-down list in the upper right of the dialog. The GIS tables that are available depend on the tables that are defined in the current template database. Use the GIS Database Settings and Define Template Database commands to setup the tables. Once you select a table to process, the fields for that table are displayed in a spreadsheet format. If a field is related to a field in another table in the database, a "+" character is shown next to the field name. Picking the "+" will open another dialog box with the related data in the other table. The data in this related table is not editable, only the data in the initial linked table.

The bottom portion of the dialog has features for attaching images to the entity. Existing image files (BMP, JPG or GIF) can be linked by choosing the New option. The Update option will replace the current image with a newly selected image. The Delete option will remove the current, attached image. The Capture button will take a shot in the field using a configured camera and then attach the image to the entity. Different digital cameras can be used by picking Pick or Set Camera.

The Input-Edit GIS Data command is an excellent way to simply review the data associated with an entity. If the entity has GIS data, the banner line at the top of the dialog will display "Entity has GIS Data". If not, the banner line will display "Entity has no GIS Data". Even when the entity has no data, the default values for the prompts will
appear. Pressing OK will assign this data to the entity. To avoid assigning data to the entity (if it has none), press Cancel. Alternately, you can use the commands GIS Inspector Settings, followed by GIS Data Inspector, to review the data with no possibility of editing or inputting data in the process.

There are three methods for selecting the drawing entities to process: S for Select, P for Pick and N for Number:

**Select Object method:** With this method, you pick the drawing entity to process the data attached to that entity. When selecting a Carlson point, the point number is used to link to the database.

**Pick method:** For this method, you pick inside a closed polyline to process the data attached to that polyline.

**Number method:** Here you simply input the point number from the current CRD file to process.

**Prompts**

Select object (Number/Pick/<Select>): \textit{P}

Pick a point inside polygon (Select/Number/<Pick>): \textit{pick a point}

GIS Smart Prompting dialog \textit{make selections}

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** gisdata

**Prerequisite:** MDB GIS prompting must be created in Define Template Database and points or entities must exist to link GIS information to.

**GIS Inspector**

This command displays all or portions of the data attached to drawing entities in real-time. How much of the attached data is displayed is set by the command GIS Inspector Settings. When you move the cursor over an entity with GIS data, selected fields are displayed in a tooltip box next to the cursor. For data attached to closed polylines, you can move the cursor anywhere inside the polyline to show the data. Polylines that are closed will highlight with a solid fill as you inspect each one. Open polylines, such as road centerlines, will highlight with a solid fill generated along the length of the polyline. The solid fill color for all highlighting is set in GIS Inspector Settings.

The routine starts by prompting you to select entities. The entities that you select will be used by GIS Inspector. In the case of a large drawing, this selection allows you to limit the entities for inspector to a local area instead of having to process the whole drawing. Then after reading the entities, you can move the cursor around the drawing to inspect the GIS data. You can also use the arrow, page up and page down keys to pan and zoom the display. Pressing enter ends the routine.

**Prompts**

Select objects: \textit{select entities with attached data}

Arrow keys=Pan; PageUp/Down=ZoomOut/In;
Pulldown Menu Location: GIS Data
Keyboard Command: gis_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and entities must have linked GIS information.

GIS Inspector Settings
This command sets up the fields to be displayed when using GIS Data Inspector. Each GIS table code can have different display options stored in the GIS Inspector Settings command.

GIS Inspector Settings reads all the points and entities with GIS information currently linked in the drawing and displays a list of the linked data tables under the Available GIS Table column. When a GIS Table code is highlighted (i.e. 0001 or Road), the fields for this GIS table are displayed to the right in the Select Fields column. Up to 6 fields or lines of GIS data can be defined for display for each GIS code table, including one picture. To add a field to the display list, double-click on the field name. To remove a field from the display list, highlight the GIS table to remove from and then use the Clear Settings buttons. The Last Option button will remove the last field to display from the current GIS table. The Picture Name will remove the image from the display list. The Entire Line button removes all the fields from display for the current GIS table.
**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** `set_inspector`  
**Prerequisite:** MDB GIS Prompting must be created in *Define Template Database* and points or entities must have linked GIS information.

**GIS Query/Report**

This command applies a user-defined query on a data table or related tables with the database. Records in the table that pass the query can be reported or the associated entities can be highlighted in the drawing. The *Query Using* option in the main dialog box sets the source of the data table to process as either GIS data attached to selected drawing entities or from the current Output MDB file.
The query is defined in the dialog shown here. To add a query, enter a new query name in the in the space underneath Current Query. If there is already a name there, just highlight and type over it with a new name, then hit Clear All to clear out existing query lines and get full access to all Feature Names.

The top portion of the dialog contains a list of the query parameters. To add a parameter, select a Feature Name from the pop-up list. The available features will either be all the features found in the GIS links of the drawing or all the features from the Output MDB file depending on the Query Using option. Once the feature is specified, the Field Name pop-up list contains all the available fields in the feature. Choose a field from this list. Next choose the operator (=, >, etc.) from the operator list. The Value pop-up list contains all the different values for that field that are found in the current data set. You can either select one of these values or type in another value into this field. If a Field Name relates to another Feature, when you select that Field, an additional button will appear allowing you to add a query parameter from the related feature.

When all the parameter values are set, pick the Add Parameter button. Once a feature is selected and add a parameter is added, the Feature Names list becomes unavailable because any additional query parameters must come from that feature, or relate through that primary feature.

When all the parameters are defined for the query, you can save these settings by filling out a name Current Query field and then picking the Save button. This query can be recalled later by highlighting the query name and clicking the Load button. The Delete button removes the highlighted query. The Save, Load and Delete functions operate on the current set of queries active in the program. The Save To File and Load From File functions read and write the collection of queries to a .QRY file for managing different sets of queries and sharing with others.

Pick the Execute button to process the query. The Mark Screen Entities option will set the color of entities with GIS data that match the query to the specified color. The Build Selection Set option creates a selection set of the entities that pass the query. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt. With the Generate Report option, the program will bring up the Report Formatter which allows you to choose the fields to include in the report and the report format. If the Highlight Screen Entities option is on, then the program will highlight the entities with GIS data that pass the query. Point entities are highlighted by drawing
a box around the point and polylines are highlighted by solid fill. Shown here is the report for all manholes with a Condition of Good.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** gis_query  
**Prerequisite:** MDB file with data or entities with linked GIS information

---

**Hatch GIS Polylines**

This command hatches closed polylines with attached GIS data based on the value of a specified database field. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the database field to process. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process and then choose a field to process by clicking on the down arrow underneath Current field. Next you can specify the color, hatch pattern and layer for each zone. The Auto button can be used to quickly fill out the hatch zones. The Show All The Distinct Values option chooses between processing as series of ranges or individually for each data value. Applications include hatching all commercial property red and residential yellow, coloring buildings by type of construction material, coloring properties by type of ownership, etc.

The Draw Legend option will create a legend of the hatch zones. The Erase Old Hatches button will erase any existing hatches inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Hatch button to hatch the polylines. When using solids for the hatch pattern, the Solid Fill Float command in the View menu can be used to make the polylines appear on top of the solids.

**Prompts**

**Select objects:** select closed polylines with GIS data
Example country polylines hatched by population range field

Pulldown Menu Location: GIS Data
Keyboard Command: hatch_polygon
Prerequisite: Closed polylines with linked GIS data

Mark GIS Polylines
This command draws new polylines as markers along selected existing polylines. The new polyline markers are drawn with width and color based on a query of the attached GIS data. The program starts by selecting open or closed polylines in the drawing with GIS data. Then a dialog appears for specifying the database field to process. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process and then choose a field to process. Next you can specify the color and width for each data value. The Auto button
can be used to quickly fill out the color and widths. The Show All The Distinct Values option chooses between processing as series of ranges or individually for each data value.

The Draw Legend option will create a legend of the marks. The Erase Old Marks button will erase any existing polyline markers from the selected polyline. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the marker polylines.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** trace_polyline  
**Prerequisite:** Closed polylines with linked GIS data

### Data Capture Text By Sample

This command automates data transfer from text entities to a database table. Many drawings are warehouses of information. The Data Capture Text By Sample command applies to drawings that contain text annotations which show the information about the objects in the drawing.

The command starts by prompting you to select one sample of the text to capture. This sample selection should consist of one instance each of the data fields to process. In the example below, the sample selection includes the
property id, owner’s name, property value and date.

Next, there is a dialog for specifying the text fields to capture and their order. Optionally you can convert the text entities into blocks by turning on the Create New Blocks option. Each sample text field is available to make into a block attribute by moving these fields to the block attribute list. In the New Block Name and Layer Names fields, you can specify the name and layer for the blocks. The Delete Objects option will erase the text entities. In the Block Attribute Properties spreadsheet, you can set the block tags, prompt, default and layer for each attribute.

The second dialog setups up the database table to create from the text data. The destination database is set with the Select Output MDB File button. You can either create a new table in the database or select an existing table. Under Table Design, you can set the Field Name and Field Type for each attribute when a new table is being created. When adding to an existing table, the Field Name and Field Type are read from the existing table. For with an existing table, the Field Name list in the lower left will show the field names from the existing table, and the order of these fields should be set to match the order of corresponding the text fields. The Use Key Field To Match Value option will use the selected record as the key field for the database table. The key field must have unique values for each record in the table. To set the key field, highlight the record row # in the spreadsheet and then pick the Select button. The Create Carlson GIS Links option will link the database table with the drawing entity for each record.
After the dialogs, there is a command line prompt to select the text entities to import. The program uses the sample text layout to find matches sets of text data in the text to process selection set.

**Prompts**

Select sample text to capture.
Select objects: pick one instance of each type of text field
Data Capture dialogs
Select entities to process [Select/<All>]: all
Created 3 GIS Links.
Done

Pulldown Menu Location: GIS Data > Data Capture
Keyboard Command: cgis_gettxtbysmp
Prerequisite: Text entities

**Data Capture Enclosed Text**

This command automates data transfer from text entities to a database table. Many drawings are warehouses of information. The Data Capture Enclosed Text command applies to drawings that contain text annotations which are within linework perimeters.

The command starts by prompting whether to identify the text to process by Group or by Layer. For the Group method, you to select one sample of the text to capture. This sample selection should consist of one instance each of the data fields to process. In the example below, the sample selection includes the property id, owner's name, property value and date. For the Layer method, the program will find all the different layers for the text entities and you can select which layers to use. For the Layer method, each type of text field should be on separate layers.
Next, there is a dialog for specifying the text fields to capture and their order. With the Group method, the text fields will show the values of the selected text. With the Layer option, the text fields will show the layer names. There is an option to convert the text entities into blocks by turning on the Create New Blocks option. Each sample text field is available to make into a block attribute by moving these fields to the block attribute list. In the New Block Name and Layer Names fields, you can specify the name and layer for the blocks. The Delete Objects option will erase the text entities. In the Block Attribute Properties spreadsheet, you can set the block tags, prompt, default and layer for each attribute.
The second dialog sets up the database table to create from the text data. The destination database is set with the Select Output MDB File button. You can either create a new table in the database or select an existing table. Under Table Design, you can set the Field Name and Field Type for each attribute when a new table is being created. When adding to an existing table, the Field Name and Field Type are read from the existing table. For an existing table, the Field Name list in the lower left will show the field names from the existing table, and the order of these fields should be set to match the order of corresponding text fields. The Use Key Field To Match Value option will use the selected record as the key field for the database table. The key field must have unique values for each record in the table. To set the key field, highlight the record row # in the spreadsheet and then pick the Select button. The Create Carlson GIS Links option will link the database table with the drawing entity for each record.

After the dialogs, there is a command line prompt to select the text entities to import. For each text entity, the program finds the boundary perimeter from the drawing linework that encloses the text. These boundaries are used to separate the text labels into the groups that make up the table records.

**Prompts**

Select text to capture [Group/\(<\text{Layer}\)>]: \textit{L for layer}

Data Capture dialogs

Select entities to process [Select/\(<\text{All}\)>]: \textit{All}

Created 3 GIS Links.

Done

Pulldown Menu Location: GIS Data > Data Capture

Keyboard Command: cgis_getencIxtxt

Prerequisite: text entities within linework perimeters

**Data Capture Block Attributes**

This command automates data transfer from block attributes to a database table. Many drawings are warehouses of information. The Data Capture Block Attributes command applies to drawings that contain blocks with attribute
The command starts by prompting to select one sample of the block to capture. The program reads the attribute names from this sample block. This example uses Carlson point blocks that have attributes for point number, elevation and description.

Next, there is a dialog for specifying the attributes to capture and their order. Each sample attribute is available to capture by moving these fields to the block attribute list. There is an option to create a new block out of the selected attribute by turning on the Create New Blocks option. In the New Block Name and Layer Names fields, you can specify the name and layer for the blocks. The Delete Objects option will erase the source block entities. In the Block Attribute Properties spreadsheet, you can set the block tags, prompt, default and layer for each attribute.

The second dialog sets up the database table to create from the block data. The destination database is set with the Select Output MDB File button. You can either create a new table in the database or select an existing table. Under Table Design, you can set the Field Name and Field Type for each attribute when a new table is being created. When adding to an existing table, the Field Name and Field Type are read from the existing table. For an existing table, the Field Name list in the lower left will show the field names from the existing table, and the order of these fields should be set to match the order of corresponding the text fields. The Use Key Field To Match Value option will use the selected record as the key field for the database table. The key field must have unique values for each record in the table. To set the key field, highlight the record row # in the spreadsheet and then pick the Select button. The Create Carlson GIS Links option will link the database table with the drawing entity for each record.
After the dialogs, there is a command line prompt to select the blocks to import. Only blocks that match the sample block names will be processed.

Prompts

Select sample block to capture: *select a block*
Processing entities...Please wait...
Select entities to process [Select/<All>] : *All*
Created 2 GIS Links.
Done

Pulldown Menu Location: GIS Data > Data Capture
Keyboard Command: cgis_getblockattr
Prerequisite: Blocks with attributes

Data Capture Add Point Data to Linework

This command captures point data (Number, Northing, Easting, Elevation, Description) from Carlson Points at the ends of existing linework and writes that data to a table in the Output database. If the selected linework has no GIS data already attached, the following dialog is displayed:
If any of the selected linework has GIS data already attached, the following dialog is displayed:

In either case, you are asked to specify what table is to be used to store the point data. Once accomplished, using Input/Edit GIS data displays the point data now associated with the linework.
Prompts

**Select linework entities:** *select linework*

**Pulldown Menu Location:** GIS Data > Data Capture
**Keyboard Command:** gisptdata2linework
**Prerequisite:** Linework and Carlson Points

### Label GIS Polyline: Closed Polyline Image

This command draws images inside the selected closed polylines with attached GIS image files. Images can be assigned to polylines by the Input-Edit GIS Data command.

The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the image to draw. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process. Then the image fields defined for this table are displayed in the lower list. Only one image can be drawn inside the polyline. The Erase Images button will erase any existing images inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.gsf) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the images. The images are drawn in the centroid of the polylines.
Example of images drawn inside closed polylines

**Pulldown Menu Location:** GIS > Label GIS Polyline

**Keyboard Command:** display_polygon_image

**Prerequisite:** Closed polylines with linked GIS images
Label GIS Polyline: Closed Polyline Data

This command draws text labels for the specified fields inside the selected closed polylines with attached GIS data. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn center justified in the centroid of the polylines.

Pulldown Menu Location: GIS > Label GIS Polyline
Keyboard Command: display_polygon_image

Chapter 8. GIS Module

1849
Prerequisite: Closed polylines with linked GIS information

**Label GIS Polyline: Open Polyline Data**

This command draws text labels for the specified fields along the selected polylines with attached GIS data. The program starts by selecting polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels for the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn along the polylines.
Example of text labels along polylines with GIS data

**Pulldown Menu Location:** GIS > Label GIS Polyline  
**Keyboard Command:** label_arc_text  
**Prerequisite:** Polylines with linked GIS information

## Links Manager

This command displays the GIS links for the selected entities and includes functionality of the Input-Edit GIS Data, Create Links and Erase Links commands. The command starts by prompting you to select the entities to process. Then the program displays a dialog with a list of all the selected entity types (POINT, LINE, etc.).

To review and edit GIS data, highlight an entity type and the program will then list all the entities for that type. If a table is attached to the entity, the table name is displayed. Otherwise the entity reports "NO TABLE". The current table is shown in a spreadsheet editor at the bottom of the dialog. When you highlight an entity from the list, the linked record in the table is shown in the first column of the spreadsheet. Also the drawing is zoomed to the entity and a highlight box is drawn around the entity. You can use the arrow and magnify glass buttons to pan and zoom the display. The arrow, page up and page down keys also pan and zoom the display.

To add GIS data, highlight an entity from the list to process that has NO TABLE. Then select a table from the table pulldown list. The available tables for this list come from the Template MDB database shown in the top of the dialog. The spreadsheet then shows a record in the first column. Fill in the values and then pick the Create GIS Link button.

To erase a GIS link, highlight an entity from the list and pick the Erase GIS Link button.

The Create Field for Images button will add a field to the current table for image files. To add an image file, highlight the image field in the spreadsheet and press the Insert (Ins) key.

Under the Settings button you can set filters for the GIS links to process based on layer names, colors, polyline type and link status. You can also set the zoom factors for the screen display.

## Prompts

**Select objects:** Select the entities, with linked GIS information, to process.
Create Links

This command makes GIS links between blocks in the drawing and a database table using a key field that is in both the block attributes and the database table. Both the block entities and database records must exist before running this routine.

The routine starts by prompting you to select the block entities to process. Then a dialog appears for choosing the block attribute and table to link. The current template and output database file names are shown at the top of the dialog. Use the GIS Database Settings command to set these file names before running Create GIS Links. The dialog lists all the block names that were found in the entity selection. Choose a block name to process. Then in the lower left of the dialog, there is a list of the attributes for the selected block. Highlight the attribute name that contains the point ID key field for the blocks and then pick the Select First Key Value button. For each block entity, the program will use the value of this attribute to link to the record in database table. This value is matched to the database record using the PT_ID database table field. For example, a block with an attribute value of 402 for the specified attribute name will be linked to the database record with a value of 402 in the PT_ID field.

Pulldown Menu Location: GIS Data
Keyboard Command: link_manager
Prerequisite: Entities with linked GIS information
Next, the database table needs to be specified to either one fixed table name or to table names defined by a block attribute. A list of the available tables in the current output database is displayed. To link all the blocks to one table, highlight the table name from the list and pick the Select Second Key button. Or to link the blocks to various table names based on a block attribute, highlight the attribute name and pick the Select Second Key button. This attribute value for the blocks will then need to contain the database table name. For example, consider a block for electric utility data with two attributes: ID and TABLE. The ID is a number to use as the first key and the TABLE is the table name (i.e. POLE, BOX). Once the key fields are set, pick the OK button to create the links.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** create_links  
**Prerequisite:** Block entities with attribute IDs and a database table with matching IDs.

---

**Erase Links**

This command removes all the GIS links from the selected entities (polylines, blocks, etc.).

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** erase_links  
**Prerequisite:** Entities with GIS links

---

**Audit Links**

This command checks the GIS links for the selected entities in the drawing to make sure that the template database, output database and table exist. Any invalid links can be erased from the entities or be fixed by selecting another database or table. For example if a database file (.mdb) has moved to another directory, then you can use this command to specify the new location.

The routine starts by prompting you to select the entities to check. If no errors are found, then the routine is done. When there are errors, a dialog box appears. Each GIS link is defined by a template database, output database and table. For each combination of these three settings that have an error, this dialog displays the template database, output database and table name from the entities. The number of GIS link combinations with errors is shown in Table Used for Links field (i.e. 1 of 2). The template database is shown at the top. If the template database link is broken, then use the Select New Template MDB button to assign another template database file. The output
database also has a Select New Output MDB to set the output database file. In the lower left of the dialog is a list of the table names from the output database. You can choose the table to use for the link from this list. The Fix Links for Current Table button will assign the template database, output database and table name from the dialog to all the selected entities. The Erase Links from Table button will remove these broken links from the entities. The Go to Other Table button will process the next GIS link combination with errors.

Pulldown Menu Location: GIS Data
Keyboard Command: audit_links
Prerequisite: Entities with GIS links

Create GIS Polylines by Interior Text
This command works with either Interior Text or Entity Handles. The initial choice of which to work with determines which dialog is displayed. In either case, the dialog box displays Tables from the Output MDB on the left, and the available Fields from that Table on the right. The use of Text gives the option of creating new GIS polylines on a specified layer by taking each text entity and creating a closed polyline around the text from the selected linework, using the text value as a field in the GIS data. If this option is not selected, the GIS data is added to existing polylines. Using Handles does not allow for the option to create new polylines.

Prompts

Use as key to match the records from the table Interior Text or Entity Handle[<Text>/Handle]? press Enter
Select lines, polylines and text. select objects

For the Handle option:
Use as key to match the records from the table Interior Text or Entity Handle[<Text>/Handle]? press H
Select lines and polylines select objects
**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** cgis_txt2pl  
**Prerequisite:** Text

### Ersi ArcGIS Services - Retrieve Map

The Retrieve Map command allows the user to select from a list of Esri ArcGIS map services or user defined map services from other public and private sources. Upon execution the ArcGIS Map Services dialog is displayed. The default "home" service is ArcGIS online. Additional map services can be added by clicking the **Browse** button to the right of the Map service dropdown list.
To add a map service type the url in the **Add** field and press enter, then click the **Add** button. After adding all the services desired click the **OK** button. All map services that have been added will be displayed in the Map Service dropdown list.

When a map is selected from the Map Service tree window, additional information is displayed in the Description panel. The amount and detail of information will vary depending on the information that the providing organization has made available. The **Enable** toggle under the description activates the Layer field allowing a layer name to be specified for the map to be placed on.

**Note:**
• The Enable toggle on the main description must be on in order to place a map. If it is not on the command will simply exit when the OK button is clicked.

If there are multiple features included in the map individual features may be selected by highlighting them in the Layers and Tables tree display. Similar to the overall map additional information available from the map service will be displayed as each feature is highlighted. Toggling on the Enable option selects the highlighted feature. The Field dropdown list can now be used to select the attribute data desired and apply operators to filter the data.

• **Field** - Available fields will vary depending on the service and data selected
• **Operator** - Available operators include; =, < >, < , >, < =, > =, BETWEEN, LIKE and IN.

Note:

• When filtering data using the field dropdown list be sure to apply the filter by clicking the **Add as AND** or **Add as OR** button. No filter will be applied if there is no data in the Criteria window.

![](image)

The Layer Display panel provides options for how to display the data selected.

• **Default** - Displays the layer(s) with green dots preceding their name.
• **Enabled** - Displays the layer(s) with check marks preceding their name.
• **All + Hide Enabled** - Displays all layers except those enabled.
• **Default + Enabled** - Displays the Default and enabled layers.
• **Default + Hide Enabled** - Displays the Default layers but not any enabled layers.

**Prompts**

**First corner/Identify Entity <Current View>:** In CAD select a first corner by left clicking in an open area.
or in Cad select an entity by left clicking on it. Circles, Arcs and splines are not supported.
or press the enter key or Right click to use the current view.
The download dialog is displayed and provides information about the map being downloaded. When the data is successfully downloaded click the OK button to dismiss the dialog and display the map.

When using the ArcGIS Services commands it is expected that a know projection is defined for the current drawing. If a project has not been defined you will be prompted to define a projection (Spatial Reference) by using the Drawing Setup Command or using the Spatial reference list from Esri or Local systems.

Clicking OK will Display the Define Drawing Spatial Reference dialog box. This dialog has two tabs; Online and Local.

Type a location such as Kentucky in the search field and press enter. The corresponding spatial reference options will be displayed.
Select a projection and click **OK** button to accept it. If you are using the Online tab you will see details of the project are presented for review. Click **OK** to accept the projection. If you are using the Local tab clicking **OK** will accept the selected projection.

**Note:**

- This process to establish the drawing projection is only used if a projection has not already been selected prior to starting an ArcGIS Services command.

**Pulldown Menu Location:** GIS Data > Retrieve Map  
**Keyboard Command:** eagmsExport  
**Prerequisite:** A set projection and known location for map

### Esri ArcGIS Services - Identify Map Features

The Identify Map Features command displays the available data from a select map service that has been placed into the drawing. Not all map services support the review of data, also the data that is displayed will vary depending on the map service and the layers selected. After selecting the command you will be prompted to select the map service you want to work with.

**Select Map Service:** Select the frame of the map you want to identify features for.

The url for your map service is linked to the frame of the map displayed in CAD. By selecting the image frame the service is connected. The available layers to review are displayed
Select a layer to review by left clicking it. The following command prompt allows you to select the area of interest in the Map.

<Alt> Point/First corner/Identify Entity <Current view>: Use <ALT> Point to pick a single point with a prompt for the second point of a window.

Or in CAD select a first corner by left clicking in an open area.

Or in Cad select an entity by left clicking on it. Circles, Arcs and splines are not supported.

Or press the enter key or Right click to use the current view.

After selecting an area the Identified Features within the area are displayed. Highlighting a feature displays the attributes and values in the right hand pane.

To end the command press the escape key or click the Red X in the ArcGIS Map Services Identify dialog box.

Pulldown Menu Location: GIS Data > Identify Map Features

Keyboard Command: eagmsIdentify

Prerequisite: Map Service inserted in drawing that supports feature data.

Esri ArcGIS Services - Define Feature Class by Layer

The Define Feature Class By Layer command adds Feature Class data to the drawing so that when the drawing is brought into ArcGIS the CAD graphics can be converted easily to Esri feature classes. When executed a layer selection dialog box is presented.
Multiple layers can be selected from the list using standard Windows selection methods using the Shift key or the CTRL key.

Clicking the OK button accepts the selected layers and the Feature Class data is added. The results of the command are displayed on the command line.

**Pulldown Menu Location:** GIS Data > Define Feature Class By Layer  
**Keyboard Command:** emscDefineByLayer  
**Prerequisite:** Drawing with CAD layers and entities

### Import SHP File

The Import SHP File command converts ESRI SHP files into Carlson drawing entities and can also optionally write the available attribute data to an external Access MDB file and create GIS links between the drawing entities and the records in the database. Use the Geometry with GIS Data Import Option to accomplish this. Use the Geometry Only Import Option to just draw the linework. If you don't need the data, this option is much faster.

The Import SHP File dialog displays the Output MDB file to add data to and the source SHP file to be imported. SHP files are similar to entities in one layer in CAD. You must specify the table name to store the data in the MDB database and the layer name for the entities to be created. Typically these names are the same or near equivalent as the SHP file name. Once these names are entered, the Import Polylines from SHP button becomes available. Pick this button to import the SHP files entities and database. You can also assign elevations by a specified data attribute.

There are primarily three types of ESRI SHP files: Points, Arcs and Polygons. Each will provide different options on Import. Once the SHP file is selected, Carlson detects the data contents of the file and sets the dialog options for importing either polygons, arcs or points. Carlson GIS also supports the use of three other types of SHP files: PointM, PolylineM and PolygonM.

Both Arc and Polygon SHP files are brought into Carlson as polylines in the drawing, with attribute data stored in an external Access .MDB database file if that option is selected.

Point SHP files are imported in a three step process. The first step uses the Import SHP File command to create a coordinate file (.crd) for the points in the SHP file and a corresponding table in the output MDB file for the points database. The second is to use Draw Locate Points to draw the points from the CRD file into the drawing. The third step uses Create Links to select the points in the drawing and link the database to these plotted points.
Note: If the SHP file you are Importing is in a different Projection or Units than that specified in the Drawing Setup, then a transformation will occur during Import, as long as the (.PRJ) Projection file is present with the SHP set of files. If there is no (.PRJ) file with the SHP, then no transformations will occur.

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** import_shp
Export SHP File

This command creates a SHP file from the selected entities in the drawing. After selecting entities to be converted, a dialog shows the number of Points, Polylines (Arcs) and Closed Polylines (Polygons) found in the drawing selection set. Those Points, Arcs and Polygons with database information linked are displayed with their database table names. Any Points, Arcs and Polygons without linked database information display as unknown.

Highlight the Point, Arc and Polygon tables to output or selects Export All to select all entities including the UNKNOWN entities to export into SHP files. The Export SHP File commands outputs all entities selected into SHP files with the same name as their table name into a subdirectory selected. Also Points can be stored in the ESRI Arcview database as 3D X, Y and Z coordinates when Include Z Coordinates is toggled on. SHP files do not have arc entities. So the export routine will convert arcs and polyline arcs into a series of small chords segments. The Offset Cutoff field sets the maximum horizontal shift allowed between the original arc and the chord segments.

These SHP files can be imported into ESRI's Arcview product. Database GIS links in Carlson are converted to SHP files by storing the GIS database information into DBF files for ESRI's Arcview product to read and link to.

Prompts

Specify Name for SHP File dialog select .SHP file name
Select objects select entities
Export Carlson Entities to SHP File dialog choose settings, click OK

Pulldown Menu Location: GIS Data
Keyboard Command: export_shp
Prerequisite: None

Export DWG File with Esri MSC

This command is used to create a new drawing file that contains Esri MSC Feature data.
The drawing is scanned for MSC data and further, which are new entities with MSC, which are entities with edited geometry, and which are entities with edited attributes. The user specifies which are to be included in the new drawing file. On OK, a new drawing file name is specified.

The drawing is scanned for MSC data and the list is populated with represented Feature Classes. You can select which ones to include in the Export (Export Yes/No column). The check boxes at the bottom allow you to choose whether to Export the unmodified entities for the selected Features, new entities, entities with CAD edits, such as Trim, Extend, Move, etc, and entities with edited attributes. On OK, a new drawing file name is specified. There is also a Report function to review the changes and to make a record of these transactions.

One possible application of this command is to create a DWG from ArcGIS with its Export to CAD tool, open the drawing in Carlson and edit it, and then use this command to send the edits back to ArcGIS as a new DWG with MSC.

**Pulldown Menu Location:** GIS Data
**Keyboard Command:** export_msd
**Prerequisite:** drawing with MSC

---

**Export ESRI Projection File**

This command creates an ESRI format Projection File (ESRI PRJ) from the projection definition in Drawing Setup which must be setup before running this routine. The program prompts for the .PRJ file to create.

**Pulldown Menu Location:** GIS Data
**Keyboard Command:** write_esri_prj
**Prerequisite:** projection defined in Drawing Setup

---

**Import GIS Data from SurvCE**

This command reads GIS attribute data collected with SurvCE and Imports it into the drawing and embeds it within the point blocks in the drawing as Esri MSC that can be read directly by ArcGIS. The setup is to have a coordinate file (.CRD) set current, the points drawn in the drawing, an applicable attribute definition file (.GIS), and a file that is storing the attribute values (.VTT), that was created by SurvCE. You are prompted to pick the GIS file, and then the data from the VTT is imported and embedded within the matching point blocks in the drawing.
Export GIS Data to SurvCE

This command is used to set up a SurvCE Feature Code Library (.FCL) with attributes from points in a drawing with Esri MSC data.

In this dialog box, the coordinate file is specified, as well as the Field to Finish file being used. The name of the SurvCE FCL file is then specified. Picking OK prompts the user to select the points in the drawing with Esri MSC data.

Convert GIS Links to AcadMap

This command converts Carlson GIS links to AutoCAD Map LPN links. The command starts by prompting you to select entities to process. Then the program will read all the Carlson GIS links attached to the selected entities. A dialog is shown with a list of all the pairs of database file and table names from the GIS links. Fill in the LPN name to use for the Carlson GIS link. If the LPN does not exist, it will be created. The LPN will be registered in MapPlus, if MapPlus is available. When the LPN names are filled out, pick the Convert button and the Carlson GIS links will then be removed and replaced by AutoCAD Map LPNs. This routine will run in either plain AutoCAD or AutoCAD Map.
Convert AcadMap to GIS Links

This command converts AutoCAD Map LPN links to Carlson GIS links. The command starts by prompting you to select entities to process. Then the program will read all the Map LPNs attached to the selected entities. A dialog is shown with a list of the LPN names. In order to be able to convert an LPN, the LPN must have a key field called PT_ID. Also, the database file and table referenced by the LPN must exist. In the dialog, highlight the LPN to convert and then pick the Convert button. The Map links are then removed and replaced by Carlson GIS links. This routine will run in either plain AutoCAD or AutoCAD Map.
Define Note File Prompts

This command allows the user to create a .GIS file for use in several other routines in Carlson GIS and other Carlson Software products, such as SurvCE or SurvStar.

The program starts with the main Define Note File Prompts dialog, as shown below. The Load button allows the user to load an existing GIS file for editing or review. The list box shows the various data capture items in the GIS file, showing the field name, the prompt, the default value and the various options for that field. The Edit button allows the user to edit the highlighted field. The Add button allows the user to add new fields after the highlighted field. The Move Up and Move Down allow the user to change the order in which fields appear in the GIS file, while the Remove button completely removes the highlighted field. The Save button saves the GIS file that is currently being edited, while SaveAs allows the user to save the current GIS file under a different name. The Quit button checks to see if the current GIS file is saved and quits the routine.

When the Edit or Add button is clicked, the dialog box shown here appears, allowing the user to enter and edit data with respect to a particular field in the GIS file. The Field Name is a unique identifier of the field in the GIS file and hence a GIS file cannot have repeated field names. The Prompt is what appears at the command prompt while waits for user input. The Default Value is the value that would be used among various options, if the user presses Enter at the command prompt without typing anything in response to the prompt. The list box, Options for value, contains a list of options that can be selected for the particular field. A new option can be added to the list or removed from the list by clicking the appropriate button. The Add Option button brings up a small dialog and accepts the option to be included in the list. Press OK to accept the values set here. At the minimum, the Field Name and Prompt must be specified.

Define Note File Prompts dialog Load a file, or change variables as required.
Pulldown Menu Location: GIS Data
Keyboard Command: defnote
Prerequisite: None

Database File Utilities
This command is designed to import GIS data from SurvCE, GISCE and FAST Survey files, as well as from user-defined text/ASCII file fields. It also exports data from Carlson Note files (.NOT or .VTT) to Microsoft® Access (.MDB) database tables. The .NOT extension is used when data transfers from desktop. The .VTT extension files are data transfers from data collector.

Note files are associated with Coordinate files (.CRD) and contain additional data for point numbers. For example, the Coordinate file for a manhole point could contain the point number, northing, easting, elevation and 32 character description, while the corresponding note file for that point contains additional data on the manhole such as diameter, depth, condition, etc.. A Carlson Note file for a Coordinate file will have the same name as the Coordinate file, except with a .NOT or .VTT extension instead of the .CRD extension (e.g. PARK.NOT goes with PARK.CRD). The Carlson Note file is a text file which consists of a point number (PT_ID) followed by field names with values. This group of point number and fields can also have a GIS_FILE name, which is used to identify this group of fields. This GIS_FILE name comes from the Note file prompting definition file (.GIS), which defines the field names for the group and is created in the Define Note File Prompts command.

You can select the Note file to process by using the Import Note File button. The program will then list all the GIS_FILE names that were found in the Note file. If a set of data for point number does not have a GIS_FILE name, then this group will appear in the list as UNKNOWN.

The name of the Microsoft® Access database to add the data to is the output database file, listed at the top-left of the Database File Utilities dialog. You can change the output database by using the Open Database button and selecting an existing database, or by clicking New Database to create a new database. The database tables will automatically have the same name as the GIS_FILE. This dialog also allows you to preview and edit a spreadsheet editor, which in turn allows you to modify values in the table. Each set of note file data for a point is displayed on one row with the corresponding record from the database shown on the next row. You can export the Note file data and create a new Access database .MDB file, in Access '97 format or in Access 2000 format, by doing a SAVEAS into .MDB format. You can rename and delete a table as well.

Database File Utilities can be combined with the Create Links command to make GIS links between the point entities.
in the drawing and the Microsoft® Access database records. The point entities can be drawn with the Draw/Locate Points or Field to Finish commands.

Available Table from Output Database: Selection list. Pick a table from the Output Database.

Import Note File: Imports a Carlson Note File (.NOT).


Import ASCII File: Imports ASCII file.


Preview/Edit Table: Displays a spreadsheet editor, allowing you to preview/edit values from table.

Rename Table: For renaming a table as needed.

Delete Table: For deleting a table as needed.

Current Table: Displays the selected table from above list.
Define Block Database Links

This command creates links between attributes in drawing blocks and fields in database tables for Microsoft® Access, Microsoft® Excel and DBase. The command works through the dialog shown. At the top of the dialog, you specify the database and table to process. Highlight the database and table to process from the lists. To add a database to the available list, use the Attach Database button. This routine brings up a file selection dialog to choose the database file name. Under the “Files of type” field, you can choose between selecting Microsoft® Access, Microsoft® Excel or DBase database files.

After selecting the database table to use, the key field from the table must be specified. Highlight a field name from the Fields list and then pick the Set Key Field button. One of the block attribute links to the database fields must use this field name so that the program can link the block entity with the database record and fill out the other values. For example, consider a block with three attributes: lot_id, owner_name and area. The database table has the following fields: ID, name and area. The database field of ID could be set as the key field and linked to the block attribute called lot_id. Also the database field of name could be linked to attribute owner_name and area linked with area. Programs such as Update Block Data will use the value in the attribute of lot_id to lookup the database record with the matching value in the ID field. Then the values in the owner_name and area block attributes can be filled out from this database record.

The program lists all the block definitions found in the drawing. Highlight a block name to link to from this list. Then the program will list all the attributes for this block. To create a link, choose an attribute and a field from the database table. Then you can pick the Add Link button to link this block attribute with this database field. The links for a block can be saved and recalled by block name using the Save and Load buttons.

One application of this command is for linking drawing title blocks to a customer database. For example, the drawing title block and the database could contain a customer ID, name, address, etc. The customer ID could be used as the key field. Then you could just fill out the customer ID in the title block and then use the Update Block Data command to fill out the rest of the customer data in the title block.
Pulldown Menu Location: GIS Data
Keyboard Command: define_blk
Prerequisite: Block in drawing and database file

Update Block Data

This command fills out attribute values in drawing blocks using data from database tables. The links between the block attributes and the database fields are defined in the Define Block Database Links command.

The program starts by prompting you to select the block entities to process. Then a dialog is displayed with a list of the block names from the selected entities that also have database links defined. Highlight the block name to process from the list. Then the program lists the attributes for the block. Highlight the attribute that corresponds to the key field from the database table. Then choose the Insert/Update button to update the drawing block attributes.

Under Source for Key Values, the Drawing Attributes option will update each block by reading the value of the key attribute and then looking up the database record with the matching value. The other block attributes and then filled out using the values from this database record. The Select from Database option allows you to choose a database record by highlighting the value from the key field. All the block entities will be filled out using the values from this selected database record.

The Preview Links option will bring up a dialog with a spreadsheet view of the data values from the database for each block. You can edit the values, update the block or skip updating the current block.
Example point blocks updated from CITIES database table

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** update_blk

**Prerequisite:** Blocks, database table and link definition

### Insert Block with GIS Data

This command draws block entities in the drawing with the attributes filled out using data from a database. The command works through the dialog shown. The MDB File is the database that to be used as the source for the attribute data. The CRD File is the coordinate file that contains point number, northing, easting, elevation, and description. A list of the block definitions found in the drawing is shown on the left. To add a block to this list, pick the Select Block File. Highlight a block name from this list. Then the program will display a list of the block
attributes. The tables defined in the current MDB database are listed in the lower left of the dialog. Highlight a table name to use for the data source. Then in the attribute list, for each block attribute you can set the database field to use for the attribute value by selecting the Field Name pulldown arrow. In the lower right of the dialog, you can specify the layer name, scale factors and rotation for the blocks.

Pick the Draw button to create the blocks. For each point number in the coordinate file, the program will insert the specified block in the drawing using the point coordinates from the CRD file. The database record to use is found by matching the point number from the coordinate file with the PT_ID field in the database table.

Pulldown Menu Location: GIS Data
Keyboard Command: insert_blk
Prerequisite: CRD file and MDB database table file

**GIS Tools Menu**

The GIS Tools menu shown below has commands for processing polyline perimeters, images and other utilities.
**Process Layerized Text**

This routine is a simplified version of the Polygon Processor command. It uses closed polylines that enclose text. Each text label is used as the data value for the enclosing polyline. The text and polyline must have the same layer name and together they define one layer or topology. This command processes multiple layers by overlaying the layers and finding all the sub-areas. For example, one layer could be used for property boundaries with the property name inside the closed polylines. Another layer could be for soil types. This command could then be used to find all of the different areas broken out by property and soil type (Property 1-Soil 1, Property 1-Soil 2, etc.).

There is an option to draw closed polylines for the resulting sub-areas. You can also label each sub-area with the layer data values for the area (i.e. Property 1/Soil 1). The program also generates a report of the sub-areas, including the data values for each layer, the area and the perimeter. The Report Formatter is used to choose the fields to include in the report and the report layout. There is no explicit link to a database, but the Report Formatter will print and/or save a file of the displayed information, or export the data to Microsoft® Excel and Microsoft® Access.

The function prompts you for a selection set containing the closed polylines and text to be processed. The layer list is formed from the selection set, and you have to specify the sequence in which layers will be processed.

**Prompts**

- **Select objects**: choose selection set
- **Draw resulting polylines [No/<Yes>]?** press Enter
- **Draw name labels [No/<Yes>]?** press Enter
- **Layer name for resulting polylines : Property**
- **Select a Layer processing sequence dialog** specify the sequence
- **Report Formatter Options dialog** customize as needed

**Two-Layer Example:**

Two properties (Johnson and Hayes) straddle Soil A, Soil B and Soil C. Note that some of the Hayes property extends beyond the soil polygons. If the properties are "cut" against the Soils, portions of the properties that extend where there are no soil zones will get a blank designation for the soils layer. This command offers a quick method
of distinguishing every category of property. In our 2-layer example, the text "Soil A", "Soil B" and "Soil C" are in the same layer as the soil perimeters, and the text "Hayes" and "Johnson" are in the same layer as the property perimeters. Note also that "Soil C" is located inside both the soil and property perimeters. This is OK since it is associated only with the soil polygon because the text and polygon share the same "soil" layer.

PROPERTY SOILS Area Perimeter
Hayes 2,713.8 265.12
Hayes SOIL A 80,925.3 1,161.56
Hayes SOIL B 6.9 12.69
Hayes SOIL C 3,960.4 330.70
Johnson SOIL A 2,229.6 229.38
Johnson SOIL B 9,072.0 521.80
Johnson SOIL C 89,665.2 1,276.69
-- Grand Total ----------
188,573.1 3,797.95

Pulldown Menu Location: GIS Tools
Keyboard Command: layertopo
Prerequisite: None
Create Unique Polylines

This command takes in a selection set of polylines and lines, and creates a new layer of unique lines, without duplication. They can then be successfully used for topology creation. In the example below, polylines for properties and a floodplain, with several duplicated sides, are used to create a new layer consisting of unique, non-duplicated lines. The text shown is for information only and is not critical to the process.

Prompts

Enter layer name for polylines <CLAYER>: press Enter
Select polylines:
Select objects: select polylines or lines

Source Drawing

Output drawing isolating to new layer
Certain line segments are highlighted

Pulldown Menu Location: GIS Tools
Keyboard Command: createunipl
Prerequisite: Polylines or lines

Label Object Data Areas

This command labels selected Object Data fields within MPolygon areas with smart rules for different methods to handle any labels that overlap the area perimeter. This command requires AutoCAD Map 2006. The program starts by prompting for the object data table name at the command line. To check the object data table name of an MPolygon entity, double-click on the MPolygon to bring up the Properties dialog. In the dialog, object data is shown in sections labeled OD:Object Table Name.

Chapter 8. GIS Module
After selecting the object table name, there is an options dialog. The dialog lists all the field from the object table and you can select which fields to label by adding them to the list on the right. The Annotation Rules are used to position the labels. The rules are applied in order until the labels fit inside the MPolygon. You can choose which rules to use and their precedence:

Inside Area At Centroid: Places the labels at the centroid of the MPolygon.
Inside Area Not At Centroid: Searches for any space inside the MPolygon that fits the labels.
Resize To Fit Inside Area: Places the labels at the centroid of the MPolygon at smaller text sizes. The options for this rule control the minimum size to use and the size increments to try starting from the initial size.
Outside Area With Leader: Places the labels outside the MPolygon and draws a leader from the label to the MPolygon center. The options for this rule control the max length of the leader as a factor of the text size, the size of the leader arrowhead, and the number of directions to try as leader positions.
Outside Area With Table: Places the labels in a separate data table and a data id label inside the MPolygon. The settings for this rule control the size of the table and the id label.

Prompts
Define Area Layers

This command sets up a list of layer names for use with the Report Areas By Layer command. For each layer in the list, an Area Type is assigned which is used for reporting in the Report Areas By Layer command. You can also specify hatch parameters for each layer. These hatch settings are used by the Hatch All and Hatch Selected functions. The Hatch All function hatches all the closed polylines in the drawing on the defined layers. The Hatch Selected function hatches only the currently highlighted layer. The purpose of these hatch function is to visualize and verify the areas. The Add, Edit and Delete buttons are used to manage the list of layers. The Load and SaveAs functions allow you to save and recall the defined layers to a .ALF file.

Report Areas By Layers

This command reports the area within a closed polyline broken out by sub-areas for areas on defined layers. For example, the main perimeter polyline could be the property boundary and the defined layer polylines could be for wetland areas. Then this routine would report the overall property boundary along with the wetland area.

The layers to process are setup in the Define Area Layers command. The defined layer polylines need to be closed polylines. The program finds all the defined layer areas within the main perimeter polyline and layer polylines that
cross the perimeter are automatically trimmed to get the area within the perimeter. The program uses the report formatter to display or export the results.

**Pulldown Menu Location:** GIS Tools  
**Keyboard Command:** report_area_layers  
**Prerequisite:** Define Area Layers

### Polygon Processor

This routine takes sets of shapes representing land features and generates a set of non-overlapping shapes, where each shape has data attached from all shapes in the original sets it intersects. The input shapes in one layer designate one property like: lease, owner, county and etc.

Properly prepared data should follow these rules:

1. Each property layer should consist of polylines/lines and text.
2. Lines and polylines should form complete loops, with no ends not snapped to the end of the same or other line/polyline.
3. Each formed loop should contain one and only one unique text entity representing the property value for that loop. Multiple entities with the same text are permitted within the loop.
4. Corresponding text and lines should be on the same layer.

Once all the necessary entities are selected, the routine will separate entities by layer and then analyze each layer for compliance to the rules above. If problems are found, the XXXX_ERR layer is created (where XXXX is original layer name) with marks to help locate the problem. The loose ends are marked by placing a circle with center on the endpoint of the line/polyline. The loops with no text value inside are drawn in red color and ones with too much text are drawn in green.

Layers with no problems are processed and the resulting loops are created on the XXXX_RES layer. If all the layers where analyzed successfully with no problems found, these result layers are combined and one final layer called POLYPROC is created with each loop-piece bearing the data from all loops on other layers it belongs to. That data are stored as extended entity data in name-value pairs, where name is a name of the original layer.

### Prompts

**Select objects:** select shapes and/or polylines  
**Pulldown Menu Location:** GIS Tools  
**Keyboard Command:** polyproc  
**Prerequisite:** Shapes and/or polylines

### Polygon Inspector

This routine allows you to review quickly the results generated by the Polygon Processor. As the cursor moves over a polyline with attached results, the information from that polyline is displayed and the polyline is highlighted.

For more extensive analysis of the data resulting from Polygon Processor, please refer to the Polygon Query command.

**Pulldown Menu Location:** GIS Tools  
**Keyboard Command:** polyproc_inspect  
**Prerequisite:** None
Polygon Query

This routine provides the ability to analyze, search and represent data generated by Polygon Processor.

A query is defined based on the parameter name (original layer name) and a condition. Several expressions may be combined using ANDs or ORs to produce a complex query. To verify the query, click on the Calculate button and the number of matching polygons will be reported.

The values stored in the polygon areas are text strings from the original text labels used in Polygon Processor. The expressions are evaluated on these text strings, but the program will compare numbers embedded into strings as numbers:

- \( A12B < A50B \)
- \( A12B > A5B \)
- \( A12B < ABC \)
- \( 123 < A12 \)
- \( 5-ABC < 13-ABC \)

A complete report on all polygons matching the specified query may be obtained by clicking on the Report button. All the parameters, along with the areas and polyline handles, are shown in the standard report formatter dialog. The Hatch button applies various hatches to the polygons matching separate queries to create a visual representation of the data. To remove unwanted polygons, i.e. ones which do not contain a combination of required parameters, you may click on the Delete button. This removes processed closed polylines from the POLYPROC layer. To pre-select queried polygons to be used in some other command by means of "previous selection set", use the Select button.

Pulldown Menu Location: GIS Tools
Keyboard Command: polyproc_hatch
Prerequisite: Data generated by Polygon Processor

Polygon Export to ADE

Polygon data stored in EED form are exported to ADE format (object data), supported by AutoCAD Map. You may then use AutoCAD Map and MapPlus querying functionality to research the data. Since Map's ability to query text is limited, and data coming from Polygon Processor is always stored in text format, for each XXXX parameter in original data two parameters will be present in ADE form: XXXX with text field as is and XXXX_REAL with a number converted from text (if conversion at all is valid).

Pulldown Menu Location: Tools in GIS
Keyboard Command: polyproc_export
**Properties Converter**

This routine facilitates the user in performing massive conversions of entities in the drawing. For example, it can move all blue polylines into a designated layer or change the size of all yellow text.

The user can define a number of different conversion rule sets to work with drawings coming from various sources. Within one set, multiple rules may be selected to be executed at the same time on the set of entities.

In the left upper corner dialog sets of conversion rules may be added by clicking on the Add button. When the set name and file to store a set are specified, the set is added to a list of available ones. To pick a set for editing or to run it, highlight a particular set in the list and the list of the defined rules will appear in right upper corner of the dialog where users may either add/modify any conversion rules within the set or select rule(s) to be executed on selected entities.

When sets of rules are already defined, the dialog appears as shown below enabling the user to select multiple rules and apply them to the drawing. When a new rule is added, or when the user clicks on the Full Edit button, the dialog expands to show the actual rule definition for the currently highlighted rule. To execute rule(s), select one or more rules (hold Ctrl or Shift keys to highlight multiple items) and click on Execute button. When multiple rules are selected, these rules are applied in a top to bottom order on the entities that the user selects.

The top portion of the rule description defines additional filtering among the selected entities, allowing the user to narrow the user-provided set of entities to a small one containing only entities passing the filter. Filtering can be done by entity types, layer, linetype or color, or by any combinations of these. Filters may be defined easily by clicking on the Select button in either entity type, layer or color boxes and then selecting any entities which bear a desirable feature.

The bottom half of the dialog, Modified Properties, defines what changes will be applied to the entities which are selected and pass through the filter, if any. The following properties may be modified:

**Layer:** The current layer may be changed to any one on the fixed list of permitted layers. If this option is used, the user has no control over color or linetype, since they come predefined for every layer on the list.

**Color:** Specify color number 1..255 or BYLAYER

**Linetype:** Specify a valid linetype name or BYLAYER

More properties that may be modified are **Linetype Scale, Size, Thickness** and **Text Size.**
Pulldown Menu Location: Tools in GIS
Keyboard Command: convert_set
Prerequisite: None

Isolate Layers

This is a modified Isolate Layers command providing ability to retain entities converted by Property Converter.

This function allows the user to temporarily freeze layers which are not currently being used, to clean up the work area. By default, the function will freeze all layers which do not contain any entities modified by the Property Converter command. You may disable this behavior and specify additional entities, whose layers have to remain visible.

Prompts

Retain layers with converted entities [<Y>/N]? N
Select objects on layers to isolate.
Select objects: select entities to isolate

Pulldown Menu Location: GIS Tools
Keyboard Command: insertmark
Prerequisite: None

Insert with Join/Align

This command places the previously created smart block into the master drawing. After selecting a block to be inserted, the program finds insertion points and prompts the user to pick the corresponding points in the master drawing.

The next step is cleaning up an area of the master drawing which is now overlaid with the inserted block. The program detects the layers being affected and prompts user with a dialog which lists layers affected, asking the user
to specify the layers containing entities of the master drawing to be removed. This list contains only layers which are present in both master drawing and a block default to be removed.

After modification of the layer list is complete, the user is given a chance to review entities to be remove from the master. At first, the entities within the insertion area on the selected layers are highlighted, but the user may unselect or select entities before removal.

**Pulldown Menu Location:** GIS Tools  
**Keyboard Command:** smartinsert  
**Prerequisite:** Smart block

---

**Mark Insertion Points**

This routine defines future alignment points within the block to be inserted. It creates a point in the drawing, and that point stores the position and description of the point. When the block containing the point is inserted into the master drawing the description is used to prompt the user for the location of the matching point in the master drawing.

If one such a point is found in the block, it defines the shift. When there are two, they define the shift, rotation and scale of the block being inserted. To define an insertion point, specify the point location and a prompt you want the user to see when the block-to-be is inserted.

**Prompts**

- Select an insertion point for the marker: *pick a point*
- Type an insertion prompt *<Pick Alignment Point 1>*: *press Enter*

**Pulldown Menu Location:** GIS Tools  
**Keyboard Command:** insertmark  
**Prerequisite:** None

---

**Snap Linework To Points**

This command changes the vertices of linework (lines and polylines) to match coordinates from the current coordinate file. The purpose is to improve linework for the case of having coordinate data that is more accurate than the linework. The program prompts to select the linework entities to process and then uses all the coordinates from the current coordinate file to snap the linework vertices. Use the Set Coordinate File command to set the current coordinate file.

In the dialog, the Snap Tolerance is the max distance that a linework vertex will move onto a point. The Match Tolerance is the distance between linework vertex and point that the program will consider equal and won't move the linework vertex.

**Prompts**

**Snap Linework To Points Dialog**  
Select linework to process.  
**Select objects:** *pick lines and polylines*
GIS Image Menu

Create World File from Image Alignment
This command creates a image world file (TFW) from a TIF or JPG image. First the image file to be used is selected, and then two points in the drawing are specified along with two corresponding points on the image. The image is scaled and rotated to match the input data, and a World File is written with the specified data.

Prompts

Image File To Process: choose .TIF or .JPG file
Select First Reference Point in the Drawing: pick a point in the drawing
Select location of First Reference Point on the Image: pick a point on the image

Select Second Reference Point in the Drawing: pick a second point in the drawing
Select location of Second Reference Point on the Image: pick a second point on the image

Create Image World File
This command creates a image world file (TFW) from a TIF image. The TIF file needs to have georeference data embedded inside the file that contains the image position and pixel size. The TFW file is an externalized georeference file for this data that the Place Image By World File and Image commands use.

Prompts

Image File To Process: choose .TIF file

Create World File by Image in Drawing
Once an image has been inserted, scaled and rotated into a drawing, it may be desirable to create a "world file" (see the frequently changing Wikipedia topic at http://en.wikipedia.org/wiki/World_file for additional information) from the image so that the image can be re-inserted into a drawing at the proper placement, scale and rotation angle by using the Place Image by World File command.

A common method for inserting raster images into a drawing that don't have an accompanying "world file" would be through the use of the Place Google Earth Image command.
Prompts

Select images to process.
Select entities: Select the raster entities whose world file should be created

Pulldown Menu Location(s): Images
Keyboard Command: make_geotiff
Prerequisite: Raster image in the DWG

Edit World File

This command provides a dialog box user interface to edit the information in a World File.

Pulldown Menu Location: Images
Keyboard Command: edit_world_file
Prerequisite: None

Place Image by World File

This routine is intended for users of Carlson products that do not have the AutoCAD Map platform. If you have the Map extension available, it is recommended that you use the tool provided.

This function allows you to insert Geo-Referenced TIF files into the drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

Prompts

Select World File: choose existing .TFW or .JGW file
Place Google Earth Image

In addition to providing a graphical method for displaying feature-rich data located anywhere on the globe, Google Earth also provides the ability for software applications to extract its aerial imagery. While the positional accuracy of the Google Earth surface should be considered "approximate," it might be suitable for preliminary land-planning studies or "proof-of-concept" preliminary designs.

Consider the following example. Based on the physical screen size of the Google Earth application and the "zoom" (or "view") resolution of a project site, the following values (summarized at the bottom of the dialog box) were returned:

![Acquire Google Earth Image dialog box](image.png)

<table>
<thead>
<tr>
<th>Unit</th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feet</td>
<td>1637</td>
<td>966</td>
</tr>
<tr>
<td>Pixels</td>
<td>1366</td>
<td>809</td>
</tr>
<tr>
<td>Feet/Pixel</td>
<td>1.19</td>
<td>1.19</td>
</tr>
</tbody>
</table>

Google Earth View Area

In the sample above, the total area is calculated and displayed (0.1 mi²) along with the desired "spatial reference" coordinate system for our project site.

**Spatial Reference:** Displays the spatial reference coordinate projection system of the current drawing. The projection can be set using the Drawing Setup command.

**Extent - Current Google Earth View:** Gets the overall dimensions of the Google Earth session and displays the results in both pixels and the appropriate units of measure.

**Extent - Current Drawing View:** Gets the overall dimensions of the current CAD view and displays the results in both pixels and the appropriate units of measure.

**Extent - Select from Drawing:** Sets the overall dimensions of the Google Earth session to conform with a drawing window from CAD and displays the results in both pixels and the appropriate units of measure.

**Image Type:** Allows the ability to indicate the type of image to be placed into the drawing. Gray-scale images can be inserted into the drawing automatically, color drawings must be manually saved from Google Earth and then selected for insertion in the CAD drawing (see the *Prompts* section below).

**Image Layer:** Allows the ability to indicate the layer upon which the image should be inserted.
Note:

- Once an image has been inserted into the CAD drawing, it may be helpful to create an associated "world" file for the image in case it needs to be re-inserted into the active drawing (or an alternate drawing). Creating a "world" file assists with this task. To generate a world file, please reference the Create by Image in Drawing command.
- Once the image has been inserted into the CAD drawing, it may be helpful to control its "display order" by using the View > Display Order > Order by Layer command or View > Display Order > Send to Back command.
- The Place Google Earth Image routine fetches aerial imagery in real-time from the Google servers and requires an Internet connection to proceed. In the event that an Internet connection is not available, the following error message may be displayed: "Failed to initialize Google Earth. Please ensure Google Earth client software is functional and online".
- It bears repeating that the aerial imagery returned by Google Earth should only be used for illustrative or proof-of-concept purposes only!

Prompts

First corner/Identify Entity <Current view>: Identify one corner of a drawing window that should be used to set the Google Earth display or pick an existing entity with discreet upper and lower bounds to define a region or press Enter to use the current view (this is the same as the "Extent - Current Drawing View" option above).

Specify opposite corner: Identify the opposite corner of a drawing window that should be used to set the Google Earth display.

For Color images: Use Windows functionality (Alt+Tab) to switch focus to the Google Earth application and use the Google Earth > File > Save > Save Image command (Ctrl+Alt+S) to save the current Google Earth image. Once saved, Click OK on the Carlson alert dialog box shown above and locate/select the image just saved. Click Open when the file has been located.

- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

Pulldown Menu Location: Images
Keyboard Command: google_image
Prerequisite: Coordinate projection system, Functioning version of Google Earth, Internet connection

Convert CAL Images

This command converts .CAL format image files into .TIF format.

Pulldown Menu Location: Images
Keyboard Command: import_cal
Prerequisite: .CAL image
Import MrSID Images

This command allows you to select one or more image files in the MrSID format (.SID) and have them converted to either a (.TIF) or (.JPG) file format. Corresponding World files are also created.

Pull-down Menu Location: Images
Keyboard Command: import_mrsid
Prerequisite: .SID file

Image 3D Viewer

This command provides a 3D Viewer that can be used to show a georeferenced image draped over a corresponding surface. You are first prompted to select the image, and then a dialog appears in which you specify the source of the surface information. The surface can be either a surface file, or 3D Face entities in a drawing.
Pulldown Menu Location: Images
Keyboard Command: view_geotiff
Prerequisite: 3D Faces or TIN or GRD file for surface and corresponding georeferenced image file

**Drape Image on Surface**
This command drapes or overlays an image onto a surface. You are first asked to select the TIF image file, and then to select the 3D Faces of the surface to drape the image on.

**Prompts**

**Image File To Process:** choose .TIF file

Pulldown Menu Location: GIS Tools
Keyboard Command: drape_geotiff
Prerequisite: TIF image file and 3D faces of corresponding surface

**Create Image from Drawing**
The *Create Image from Drawing* command allows you to create a raster image of selected entities in your drawing to produce an photographic style image with a corresponding "world" meta-data file. This combination of files (*.TIF, *.TFW) allows the image to be correctly located with routines such as the Place Image by World File and Surface 3D Fly-over commands.

**Resolution:** Indicate the width of the image about to be created in pixels. Higher values permit the image to carry crisper details but increases the resulting file size at a geometric rate.

**Background Color:** Indicate the desired color of the background portion of the image.

**Note:**
- For normal (best) results, a "plan" view angle is suggested and can be accomplished through the View > Viewpoint 3D command.
- The "X-direction" limits ("X" is normal to the current angle) of the entities selected for the image will be contained by the image width (or resolution) specified above to produce a "Pixel:CAD Units" ratio. This
The TIF image produced by the command will carry an X and Y "resolution" of 72 dpi (dots per inch). For an image 1000 pixels wide, the "measureable" width of the image would be 13.889 inches and is the quotient of image width divided by the resolution (e.g. 1000/72).

### Prompts

**Image File to Create:** Specify the name of the image that is to be created.

**Select entities for image.**

**FILTER/SELECT entities:** Select the entities that are to display in the image and press Enter when complete.

**Pulldown Menu Location:** Images

**Keyboard Command:** dwg2geotiff

**Prerequisite:** Entities in the drawing

### Image Inspector

This command views images attached to entities. At the start, the program highlights all entities that have attached images. When you move the cursor over these entities, the attached image is displayed in a window. If you click within the image window, the program will start the image application editor that is setup for your system. This application, such as Microsoft Internet Explorer, depends on your Windows system setup. Also while moving the cursor over drawing entities, you can use the up/down arrows to resize the image. When multiple images are attached to the same entity, use the left/right arrows to cycle through the images.

### Prompts

**Arrow keys Up/Down=Image Size; Left/Right=Cycle Images; Pick Image=Open Image**

**Move pointer over entity with image (Enter to End):** press Enter

---

Car image displays in upper-left of drawing when cursor is over car symbol

**Pulldown Menu Location:** Images

**Keyboard Command:** view_image
**Prerequisite:** drawing entity with attached image

---

**Place Camera Symbol/Image**

This command allows you to place the location of a camera and the target into the drawing, and then attach an image to the camera. After you complete this command, use the Image Inspector command to view the attached image.

---

**Prompts**

- **Pick camera position:** *pick a point*
- **Pick target position:** *pick a point*
- **Camera symbol size:** *<4.00>: 10*
- **Draw line to target [Yes/<No>]?** press Enter

---

**Attach Image to Object dialog box**

---

**Pulldown Menu Location:** Images

**Keyboard Command:** `place_camera`

**Prerequisite:** Image file (bmp, jpg, tif)

---

**Attach Image to Entity**

This command attaches image files to a drawing entity. The possible image file formats are .bmp, .jpg and .gif. Any type of drawing entity can be used such as polyline, points or symbols. To run the command, first pick an entity on the screen. Then a dialog appears for selecting the image. First set the image directory and then highlight the image.
file name. A graphic of the image should appear in the preview window. Then click Attach Selected Image. The Capture New Image button can be used to trigger an attached digital camera to take an image. The Pick Camera and Set Camera buttons can be used to configure the camera to use.

Multiple images can be attached to the entity by picking Attach Selected Image or Capture New Image multiple times. To cycle the images in the preview, use the Next and Prev buttons. Use the Remove Attached Image to remove the image shown in the preview. Use Remove All Attached Images to clear all images from the entity.

The View Attached Image button will display in the preview window any image already attached to the entity instead of the selected image file. Also any image already attached to the selected entity is displayed in the Current Image field at the top of the dialog when nothing is selected in the file list.

**Prompts**

**Select object to attach symbol to:** *pick an entity*
**Attach Image to Object Dialog**
**Done.**
**Select object to attach symbol to:** *press Enter*

**Pulldown Menu Location:** Images
**Keyboard Command:** `set_image`
**Prerequisite:** A drawing entity and an image file

**Detach Image From Entities**
This command removes image file links from the selected entities.

**Prompts**
Select entities to remove image links from.
Select objects: select image file links

Pulldown Menu Location: Images
Keyboard Command: detach_image
Prerequisite: image file links

Audit Image Links
This command checks links between drawing entities and attached images.

Prompts
Select object to attach symbol to: pick an entity
Attach Image Dialog
Done.
Select object to attach symbol to (Enter to End): press Enter

Pulldown Menu Location: Images
Keyboard Command: audit_image_links
Prerequisite: a drawing entity and an image file

Write Block by Polyline
This command creates a smart block for future insertion into a master drawing. The block contains pre-defined insertion point(s) which define block alignment in the master drawing. This function requires a closed clipping polyline and one or two insertion points. Any linework entities which cross the specified closed polyline are broken at the intersection and only internal portions are inserted.

Prompts
Select a clipping closed polyline:
Select object: pick a closed polyline
Select smart insertion markers to include in a block:
Select objects: select markers

Pulldown Menu Location: GIS Tools
Keyboard Command: wblockpoly
Prerequisite: Closed clipping polyline

Place Image by World File
This function allows you to insert Geo-Referenced image files into AutoCAD drawings. This process requires the presence of an accompanying World file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

Prompts
Select World File: choose existing .TFW or .JGW file

Pulldown Menu Location: GIS Tools
Keyboard Command: geotiff
Prerequisite: A georeferenced image file

**Image Set Manager**

Image Set Manager is a program within Carlson GIS that is used to create image sets for CAD and SurvCE. An image set is a collection of images that cover a geographic area. Image sets can contain thousands of images which are indexed and geo-referenced in the image set database (.IDB). Once an Image Set is created, the rest of the tools in this area of the Images menu become available to view the images, Zoom on the images, Pan through them, etc...

**Supported Image Types**

Image Set Manager supports GeoTIF, TIF, JPEG, SID and BMP images. Geo-referenced, (GeoTIF), images are directly supported by reading the embedded tags in the image. TIFF, JPEG and BMP are supported with world files and the World File Editor.

**File Menu**

**Open Image Set**

Creates a new Image Set or opens an existing Image Set. The image database and set of images are stored to a project folder.

**Import Image Set**

Adds an existing Image Set to the current Image Set.

**Open Image Files**

This command will open and display individual images for processing. Geo-referencing is automatic for images with World Files or supported Geo-TIF. For GeoTIF the image coordinate positions will be displayed at the bottom of the image frame.

When the image is open the following tools become available.

**Image Brightness**: Generalized adjustment to the tonal range. This tool is useful to lighten the image for background display

**World File Editor**: Allows the user to import, view, create and edit image geo-reference information.

**Image Properties**: Displays Information about images in the Image Set.

**Tools Menu**

**Image Brightness**

The Image Brightness tool is an easy way to make generalized adjustments to the tonal range of the image.

1. Open an Image and choose Image Brightness from the Tools menu. The Image Brightness dialog box appears.
2. Drag the slider to adjust the brightness of the image. Drag the slider to the left to decrease the brightness and to the right to increase it. Values range from -100 to +100.
3. When you have finished making adjustments, click OK.
Convert to Greyscale
This command converts a color image to greyscale.

World File Editor
The World File Editor allows the user to import, view, create and edit image geo-reference information. A World File is an ASCII text file used to geo-reference image files. World files have the following format.

World File Format
1.0 <X Resolution>
0.000 <Amount of Translation>*
0.000 <Amount of Rotation>
1.0 <Y Resolution>
424178 <X Coordinate of 1,1 (upper-left pixel)>
4313415 <Y Coordinate of 1,1 (upper-left pixel)>

Image Export supports the following World File Formats.

<table>
<thead>
<tr>
<th>Image Format</th>
<th>World File</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF, TIF</td>
<td>TFW</td>
</tr>
<tr>
<td>JPEG, JPG</td>
<td>JGW</td>
</tr>
<tr>
<td>Bitmap, BMP</td>
<td>BPW</td>
</tr>
</tbody>
</table>
Image Properties
This option is used to display information on the current image.

Crop Selection
This command allows the user to crop a specific area within an image and save it as a new image.
Geo-reference by User Points
This command allows the user to pick 2 points on the image and assign coordinates to them to geo-reference the image. The user is prompted for coordinates for each point after it is picked, and then the World File Editor is displayed with the resulting data.
Change Resolution

This command allows the user to change the resolution of the image, thereby saving it as a smaller image file size.

Image Viewer

Image Set Manager has an image viewer to display the current image. Zoom level is controlled by the drop down list at the top left. The X and Y pixel position and geographic coordinates are displayed in the bottom right panel.
Image Set Menu

Add Image to Set
In order to display images they need to be added to the image database.

2. Geo-reference the image. If the image is not a GeoTIF image use the World File Editor to geo-reference the image.
3. Click Process to process and add this image to the image database. This process may take several minutes. The progress bar and dialog text will keep you informed of the progress. Large images are being clipped into smaller pieces for viewing in SurvCE. When complete click OK.
4. Repeat the above steps to add multiple images to the database. Multiple images in the same database should be contiguous. Images from different locations should be placed in separate databases.
Add Multiple Images to Set
This command allows the user to add multiple images to a single Image Set. It supports the same files as the Open Image command. Images processed with this command must be geo-referenced.

View Image Set
The View Image Set command displays information for the images in the currently selected image database. The images processed are displayed in the top panel, and the sub images of the selected image are displayed in the bottom panel.
Load Image Set
This command loads an existing Image Set into memory. Once loaded, the rest of the commands in this section of the Images menu can be utilized to view images, etc.

Pulldown Menu Location: Images
Keyboard Command: ireaddb
Prerequisite: A saved Image Set

Draw Image Boundaries
This command draws polylines in the drawing to represent the boundaries of the images in the loaded Image Set.

Pulldown Menu Location: Images
Keyboard Command: ibound
Prerequisite: A loaded Image Set

Place Image By Point
This command allows you to display images within a loaded Image Set by picking on the screen.

Pulldown Menu Location: Images
Keyboard Command: ipoint
**Place Image By Circle**
This command allows you display images within an Image Set that fall within the area of a specified circle.

**Pulldown Menu Location:** Images  
**Keyboard Command:** icircle  
**Prerequisite:** A loaded Image Set

**Image Zoom Window**
This command Zooms to an area in the loaded Image Set specified with a 2-pick Window. The image with the appropriate resolution is loaded as the Zoom level is changed.

**Pulldown Menu Location:** Images  
**Keyboard Command:** izw  
**Prerequisite:** A loaded Image Set

**Image Zoom Previous**
This command Zooms to the previous view of the loaded Image Set.

**Pulldown Menu Location:** Images  
**Keyboard Command:** izp  
**Prerequisite:** A loaded Image Set

**Image Zoom Extents**
This command Zooms to the Extents of the images in the Image Set.

**Pulldown Menu Location:** Images  
**Keyboard Command:** ize  
**Prerequisite:** A loaded Image Set

**Image Pan**
This command is used to Pan across images in the loaded Image Set. As you Pan, images are loaded as needed.

**Pulldown Menu Location:** Images  
**Keyboard Command:** ipan  
**Prerequisite:** A loaded Image Set

**Image Redraw**
This command refreshes the images in the loaded Image Set.
**Clear Image Set**

This routine clears the loaded Image Set.

**Pulldown Menu Location:** Images  
**Keyboard Command:** iclear  
**Prerequisite:** A loaded Image Set.
Takeoff Module
This command checks the status of steps needed to calculate total volumes.

**Prerequisite:** None  
**Keyboard Command:** tk_checklist

### Define Layer Target/Material/Subgrade

The Define Layer Surfaces dialog box (shown here) offers many functions that will ultimately make up the surface models used in volume and material calculations. Every entity (line, polyline, point, etc) in a drawing is assigned a layer name. Carlson Takeoff uses the entity layer names to define which entities represent the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. Any previously created triangulation file (.tin) can be set to the design or existing Target with the Surface Source drop-down set to File. In this mode, the Select File button will allow you to pick the .tin file you want to use for the Target.

When the Surface Source drop-down is set to Layers, drawing entities are assigned to target surface by their layer name. For example, if polylines representing design contours are on the layer "Final", then "Final" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other. The Define Layer Surfaces dialog has three lists for layer targets: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog. To move a layer to a target destination, highlight the desired layer, choose the target from the Move To list and pick the "Move To" button. All layers populate the "Other" target before being assigned to "Existing" or "Design".
Besides the basic three layer targets (Existing, Design and Other), you can add more target surfaces with the Add Target button. When another target is defined, there will be another tab along the top of the Define Layer Surfaces dialog. Then layers can be assigned to this additional target surface. The only pre-defined additional surface is Overexcavate. The layers that are assigned to the Overexcavate target can be modeled into the Overexcavate surface using the Make Overexcavate Surface command. Besides Overexcavate, the other additional targets are user-defined. The layer targets can be modeled using the Make User-Defined Surface command. Then these surfaces can be used in Takeoff commands by assigning them to a Takeoff existing or design surface using the Set Active Surfaces command.

**Edit Materials**

The "Edit" button activates the Edit Material dialog box (shown here) and allows you to define the Material name and Subgrade depths and names. Besides assigning target surfaces by layer, layers are also used to define material names and subgrades depths. By assigning a material name, Subgrade names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface, or tie into the design surface by a Slope Ratio if "Use Layback" is checked on. For **Area and Back Of Curb/Pavement material types, the polylines on the layer used for a Material must be closed polylines**. Carlson Takeoff supports nested Subgrade polylines for exclusion areas such as islands by counting how many Subgrade polylines surround an area. If the number is odd, then the area is included in the Subgrade. The even count regions in the area are not part of the Subgrade. To activate the Edit Material, select a layer from the list and then choose "Edit".
Include in Material Quantities Report

With this option checked on, the material that is named will appear in the Material Quantities Report. The report will include either the area of the material, the linear length of the material, or the number of items counted on the layer defining the material. This is accomplished by choosing "Area", "Linear", or "Count" for the Material Type.

Set Color For 3D Drive

This option allows you to assign a color for this particular material for display purposes during the 3D view/drive simulator.

Material Type

This will report the subgrade by area, linear length, count, or as curb/pavement area. If you choose Back of Curb/Pavement then you can pick on the Curb Dimensions button and bring you to the below dialog:
When the Back of Curb/Pavement, the 3D polylines represent the back of curb elevations. The program will adjust the design surface for the height of the curb above ground to get the elevations to the top of pavement. Then the program will apply the subgrade depths. Also with this option, the program will calculate your curb volume as well as act as the limit of the pavement. The pavement limit will be from the Back of Curb polyline offset by the length of the Curb base. In the above case the base is 30 inches wide. Therefore, the pavement area will stop 30 inches before the Back of Curb polyline.

**Material Cost Per Cost Unit**

Use this field to add the value of the multiplier for the unit cost of your material. If the material type is an area that has multiple subgrades, use the available fields below to add each individual subgrade name, depth and cost value per unit type. If a linear or count type material type option is selected, use the "length in feet", or the "count" unit options.

**Adjust Design Surface by Depth**

This determines whether the subgrade depths are incorporated in the design surface or not.

**Use Vertical from Pad to Surface**

This will interpolate the surface model out to your layer and then vertically adjust the model to tie into the layer. With this checked off, the program will directly interpolate a surface model between your layer and the elevated entities around it.

**Area Subgrades**

**Depth Units**

Select the "feet" or "inches" as the unit value desired for depth of subgrades.
Subgrade Name Depth Shrink Cost Per Cost Unit Density

Use these options for areas that are represented with a single/multiple closed polygon/polygons in the drawing, but have multiple material types defining the surface. Simply name each "lift" in the area, issue a depth value and add a cost unit if desired, or click on select and choose a material from the Materials Library (see Define Materials Library for more). Carlson Takeoff will report each subgrade material value in the material quantities report. The Shrink factor is multiplied by the subgrade volume in the material quantities report and represents the fill shrinkage. A Density factor can be entered in when using Cost Per Tons.

If user entered values are needed in the report use the "Edit User-Fields” button to activate the "User Defined Features' dialog box shown here. Choose the "Add” button to define needed fields such as TONS of material or BAGS OF GRASS SEED for reporting options.

Once all of the material subgrades, depths and cost units or user defined units have been defined, select save to preserve the settings in a .trg file, the "save as” function allows the user to name the file to load later.

Prerequisite: None
Keyboard Command: define_tk_layers

Edit Selected Layer
Use this command to click on any layer and advance to the Edit Materials dialog from the Define Layer Target/Material/Subgrade command.

Prerequisite: none
Keyboard Command: edit_tk_layer

Set Layer For Existing
Set Layer For Existing allows the user to pick the layers from objects on the screen and assign them to the Existing Layer.

Prerequisite: none
Keyboard Command: set_existing_layer

Set Layer For Design
Set Layer For Design allows the user to pick the layers from objects on the screen and assign them to the Design Layer.
Prerequisite: none
Keyboard Command: set_design_layer

Set Layer For Other
Set Layer For Other allows the user to pick the layers from objects on the screen and assign them to the Other Layer.

Prerequisite: none
Keyboard Command: set_other_layer

Boundary Polyline
The Boundary Polyline options allow the user to Set the Boundary Polyline, Set the Exclusion Polylines, Clear Exclusion Polylines, Hatch the Boundary Area, Erase the Boundary Hatched area.

Set Boundary Polyline
Use this command to select the "CLOSED" polyline that defines the outer most limit of the disturbed area. This boundary should dissect the site at the point where the design contours meet the existing contours, or where the limit of work will occur. If your site contains separated areas (such as different phases or isolated sections of work), then multiple Boundary Polylines can be used. Volume calculation will take place inside this boundary.

Prerequisite: a closed polyline
Keyboard Command: tag_inclu

Set Exclusion Polylines
Use this command to select the "CLOSED" polylines the define the areas inside the Boundary Polyline that will not be disturbed. These boundaries should also be at the intersection of the proposed and existing surface. A pond or wetland that will not be removed during construction is a good example of an Exclusion Area.

Prerequisite: a closed polyline
Keyboard Command: tag_exclu

Clear Exclusion Polylines
Use this command to select polylines that were previously defined as exclusion polylines but are no longer needed as exclusion areas.

Prerequisite: exclusion polylines
Keyboard Command: untag_exclu

Highlight Boundary Polylines
This command highlights the polyline you set as the Boundary Polyline.

Prerequisite: a boundary polyline
Keyboard Command: highlight_boundary
Hatch Boundary Area

Use this command to confirm the boundary polylines that have been selected are correct. This hatched area can also be utilized in exhibits of the drawing.

**Prerequisite:** a boundary polyline  
**Keyboard Command:** hatch_boundary

Erase Boundary Hatch

This command erases the hatch drawn in the plan view.

**Prerequisite:** a boundary hatch  
**Keyboard Command:** erase_boundary

Areas Of Interest

Areas of Interest can be used to calculate volumes and material quantities within a specified area. The Area Of Interest perimeters are defined by user-selected closed polylines and each area is assigned a name. The Area Of Interest polylines can be assigned either as inclusion or exclusion perimeters for the area. You can have any number of exclusion perimeters within an inclusion but inclusion perimeters cannot be inside exclusions.

The Areas Of Interest (AOI) commands allow you to Tag/Untag Areas of Interest, Identify/Report Areas of Interest and Hatch/Label Areas of Interest.

Tag Area Of Interest

This command allows the user to select polylines and exclusion perimeters that define phases of a project. Carlson Takeoff will separate each area of interest in the volume and material reports.

**Prerequisite:** a desired polyline  
**Keyboard Command:** tag_aoi

Area Of Interest by Interior Text

This command allows the user to select text from the screen to name AOIs and linework to determine the area.

**Prerequisite:** area linework and text  
**Keyboard Command:** txt2aoi

Untag Area Of Interest

This command allows the user to remove previously tagged areas.

**Prerequisite:** an area of interest  
**Keyboard Command:** untag_aoi

Identify Area Of Interest
This command allows users to identify AOI by either picking on a polyline(s) or by searching the entire drawing. The command will then report the AOI name, layer, type, starting point, and highlight the polyline in the plan view.

**Prerequisite:** an area of interest  
**Keyboard Command:** id_aoi

### Report Area Of Interest Areas

Use this command to report the Inclusion or Exclusion area (SF), the name, the layer, and the starting point.

**Prerequisite:** an area of interest  
**Keyboard Command:** report_aoi

### Hatch Area Of Interest Areas

This command allows the user to visually see AOIs in the plain view.

The command displays a dialog for the hatch pattern, color and scale. The scale determines how spread out the pattern is within the hatch. The Automatic Hatch Scale option checks the size of the subgrade areas and sets the scale to make the pattern fit. Cycle Different Colors For Each Area will give each AOI its own color so that you can distinguish between different AOIs.

The resulting hatch areas show where the AOI is applied. Exclusion Areas of AOIs will not be hatched.

**Prerequisite:** an area of interest  
**Keyboard Command:** hatch_aoi

### Erase Area Of Interest Hatch

This command erases AOI hatching.

**Prerequisite:** hatched area of interest
Keyboard Command: erase_aoi_hatch

Label Area Of Interest Areas

This command labels the AOI name and area in the plain view.

Prerequisite: an area of interest
Keyboard Command: label_aoi

Erase Area Of Interest Labels

This command erases AOI labeling.

Keyboard Command: erase_aoi_labels
Prerequisite: hatched area of interest

Hatch Subgrade Areas

This command draws a hatch with a specified color and pattern for the area that the selected subgrade area applies to. The purpose is to allow you to visually review a subgrade area to make sure that the area coverage is correct.

The command displays a dialog to select which subgrade to hatch. The list of available subgrades comes from the layers with subgrade depths as set in the Define Layer Target/Material/Subgrade command. Then there is a dialog for the hatch pattern, color and scale. The scale determines how spread out the pattern is within the hatch. The Automatic Hatch Scale option checks the size of the subgrade areas and sets the scale to make the pattern fit.

The resulting hatch areas show where the subgrade is applied. In the example below, notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. Also note that the smaller pad area is not hatched because this polyline layer is different than the bigger pad polyline.
### Hatch Subgrades

**Select Subgrade To Hatch**

<table>
<thead>
<tr>
<th>Name</th>
<th>Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAD</td>
<td>PAD</td>
</tr>
<tr>
<td>PR-FC-CURB</td>
<td>PR-FC-CURB</td>
</tr>
</tbody>
</table>

![Diagram of a map with hatch subgrades highlighted]
Erase Subgrade Hatches
This command removes from the screen the subgrade hatches created by the command Hatch Subgrade Area.

Keyboard Command: erase_subgrade
Prerequisite: hatch subgrade areas

Draw Subgrade Hatch Legend
This command draws a legend for the subgrade areas currently in the drawing. The legend includes the subgrade names and squares of the hatch patterns. The size of the labels, size of the hatch squares, layer for the legend entities and the legend title are set in the dialog shown below. The subgrade hatches to include in the legend are automatically selected from all the subgrade hatches currently in the drawing that were created by the Hatch Subgrade Areas command.

Report Subgrade Areas
This command reports all the subgrade areas in the drawing. For each subgrade polyline, the report includes the layer name, subgrade depth, area and polyline starting point.
Sample Report:

Layer Depth Area Starting Point
PAD 1.500 21979.7 6135018.84,2190093.71
CURB 1.000 50420.2 6134994.81,2190125.80
CURB 1.000 114507.3 6135191.33,2190335.27

Pull-Down Menu Location: Takeoff > Subgrade Areas
Keyboard Command: report_subgrade
Prerequisite: Subgrade Areas

Label Subgrade Areas
This command lets you label the subgrade depth and area (in sq. ft. or meters). The label is placed at the center of the subgrade area, but can be moved with the Move command under Edit.

Pull-Down Menu Location: Takeoff > Subgrade Areas
Keyboard Command: label_subgrade
Prerequisite: Subgrade Areas

Erase Subgrade Labels
This command erases subgrade labels.

Pull-Down Menu Location: Inquiry-> Subgrade Areas
Keyboard Command: erase_subgrade_labels
Prerequisite: subgrade labels

Topsoil Removal and Replacement
The Topsoil Removal and Replacement options (shown here) allow the user to Define Topsoil removal and replacement depths, Set topsoil removal and replacement areas by selecting closed polylines, Clear the selected boundary polylines if needed, Hatch the topsoil removal and replacement areas and Erase the hatched areas.
Define Topsoil Depths

This command requires user input to define the depth, or strata, of topsoil removal and replacement. Fill in the options available in the Define Topsoil Depths dialog (shown here). Carlson Takeoff will perform four functions with these values. First, the value set for the Removal Depth, or the Top Strata if selected, will be the "defined" removal amount from the Existing Ground Surface. Second, the calculated volume of topsoil removed will be included in the reporting options. Third, the value set for the Replacement Depth will be added "BELOW" the Finished Ground Surface model. Fourth, the amount of topsoil replaced will be included in the reporting options.

When topsoil depths are defined, the volume report routines will include the topsoil quantities. These topsoil quantities are in addition to the cut/fill for the existing to design surfaces for the site.

The Removal Swell Factor and Replacement Shrink Factor are multiplied by the topsoil removal and replacement quantities respectively in the volume report routines. The Density is used to report topsoil tons when the volume report option for tons is active.

The Topsoil Offset Method choose between offsetting the topsoil depth vertically or perpendicular to the surface. The perpendicular method will result in more topsoil quantities since it represents applying the topsoil depth to the slope area of the surface whereas the vertical method represents applying the topsoil depth to the horizontal area.

Prerequisite: topsoil depths
Keyboard Command: define_topsoil

Identify Topsoil Polylines

This command allows users to identify topsoil polylines by either picking on a polyline(s) or by searching the entire drawing. The command will then report the layer name and starting point for both removal and replacement polylines. These polylines are also highlighted in the plain view.

Prerequisite: topsoil polylines
Keyboard Command: id_topsoil

Report Topsoil Areas
Use this command to report the Inclusion or Exclusion area (SF), the type, the depth, the layer, and the starting point.

**Prerequisite:** topsoil areas  
**Keyboard Command:** report_topsoil

**Label Topsoil Areas**

This command labels the topsoil type and area in the plain view.

**Prerequisite:** topsoil area  
**Keyboard Command:** label_topsoil

**Erase Topsoil Labels**

This command erases topsoil labeling.

**Prerequisite:** hatched topsoil  
**Keyboard Command:** erase_topsoil_labels

**Set Topsoil Removal Polylines**

Use this command to select the "CLOSED" polyline boundary defining the extents of topsoil removal and any "CLOSED" interior polylines that define the topsoil removal area. The layer names for these boundaries is irrelevant. You will be prompted to use the Removal Depth defined in the Define Topsoil Depths command or to customize your depth.

**Prerequisite:** polylines for removal  
**Keyboard Command:** tag_topsoil_remove

**Clear Topsoil Removal Polylines**

This command allows the user to remove and previously selected Topsoil Removal Polyline boundaries.

**Prerequisite:** topsoil polylines  
**Keyboard Command:** untag_topsoil_remove

**Hatch Topsoil Removal Area**

Use this command to display a hatch pattern over the entire area designated for topsoil removal.

**Prerequisite:** topsoil areas  
**Keyboard Command:** hatch_topsoil_remove

**Erase Topsoil Removal Hatch**

Use this command to remove the hatch pattern that defined the topsoil removal area.

**Prerequisite:** hatched topsoil
Set Topsoil Replacement Polylines

Use this command to select the "CLOSED" polyline boundary defining the extents of topsoil replacement, and any "CLOSED" interior polylines that define the topsoil replacement. The layer names for these boundaries is irrelevant. You will be prompted to use the Topsoil Replacement amount defined in the Define Topsoil Depths command or to customize your amount.

**Prerequisite:** polylines for replacement
**Keyboard Command:** tag_topsoil_replace

Clear Topsoil Replacement Polylines

This command allows the user to remove and previously selected Topsoil Replacement Polyline boundaries.

**Prerequisite:** topsoil polylines
**Keyboard Command:** untag_topsoil_replace

Hatch Topsoil Replacement Area

Use this command to display a hatch pattern over the entire area designated for topsoil replacement.

**Prerequisite:** topsoil areas
**Keyboard Command:** hatch_topsoil_replace

Erase Topsoil Replacement Hatch

Use this command to remove the hatch pattern that defined the topsoil replacement area.

**Prerequisite:** hatched topsoil
**Keyboard Command:** erase_topsoil_replace

Special Fill Areas

Special Fill Areas can be used to identify areas to report fill separately. This can be used for areas were a different type of fill is needed. Such as under a building pad. The Special Fill Areas perimeters are defined by user-selected closed polylines. Carlson Takeoff will separate the special fill volume within the Calculate Total Volume Report.

Tag Special Fill Area

This command allows the user to select perimeter polylines that define special fill areas. Note: The inclusion and exclusion polylines are selected at the same time. The polyline to the inside will be used as an exclusion polyline.

Untag Special Fill Area

This command allows the user to remove previously tagged Special Fill areas.

Identify Special Fill Area
This command allows the user to identify Special Fill Areas by either picking on a polyline(s) or by searching the entire drawing. The command line report the layer, starting point, and highlight the polyline(s) in the plan view.

**Pulldown Menu Location:** Takeoff  
**Prerequisite:** Closed polylines that represent Special Fill Areas  
**Keyboard Command:** tag\_special\_area, untag\_special\_area, id\_special\_area

### Make Existing Ground Surface

This command makes the triangulation models for the existing ground surface. There are three surfaces that are created: initial original ground (og), original ground after applying subgrade zones (ze), and original ground after subgrade zones and topsoil removal (ex). These surface files are automatically named as "filename-og.tin", "filename-ze.tin" and "filename-ex.tin" respectively. The "filename" is set to the name of the current drawing (dwg) file. Also, the file extension will be .tin for the binary format triangulation and .flt for the ASCII format triangulation. This file format is set in Configure->Takeoff.

The surface is built using 3D entities in the drawing on the layers define in Define Layer Target/Material/Subgrade command. Also, the surface elevation for any drillholes are used for the model. The subgrade zones are defined in the Define Layer Target/Material/Subgrade command. If there aren't any subgrade zones for the Existing surface, then the original ground after subgrades surface will be the same as the initial original ground surface. The topsoil removal depths and areas are set with the commands in the Topsoil Removal/Replacement sub-menu. The topsoil removal areas will lower the ground surface by the topsoil depth. If there aren't any topsoil removal areas, then the original ground after subgrade and topsoil surface will be the same as the original ground after subgrade surface.

Before running this command, the layer names for the entities on the Existing layer target must be set in the Define Layer Target/Material/Subgrade command. Also these entities must be at their proper elevations. The entity elevations can be reviewed using commands from the Inquiry menu and the elevations can be assigned if needed using command from the Elevate menu. Another prerequisite is that the Boundary Polyline must be set for the site. If the boundary has not been set, the following error message will appear.

![Carlson TakeOff Message](image)

If this error message appears, run the "Set Boundary Polyline" command and pick the CLOSED polyline representing the boundary of the site.

When the program finds errors in the existing entities, a Data Error Log dialog reports these errors. Three types of conflicts are reported: Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertices of differing elevations have the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

The Data Error Log shows the amount of elevation difference at each error. You can use the Data Error Log to review, report and draw markers at these error locations. Then you can exit the Data Error Log and fix the data errors with the commands in the Elevate menu or other drafting tools. After these errors are fixed, you can run Make Existing Ground Surface again.
Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.

**Zoom To** pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

**Zoom In** zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

**Zoom Out** zooms out away from the highlighted area.

**Report All/One** toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.

**Draw All/One** toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

**Continue** closes the Error Log and proceeds with the contouring operation.

**Settings** has controls for the tolerances for error reporting and for the Layer Name and Symbol Size to use with the Draw function.

**Keyboard Command:** mk_exist_tin

**Prerequisite:** a boundary polyline and elevated entities on the Existing layer target

---

**Make Design Surface**

This command makes the triangulation models for the design surface. There are three surfaces that are created: initial unadjusted design (bs), design after applying subgrade zones (zn), and design after subgrade zones and topsoil replacement (fn). These surface files are automatically named as "filename-bs.tin", "filename-zn.tin" and "filename-fn.tin" respectively. The "filename" is set to the name of the current drawing (dwg) file. Also, the file
extension will be .tin for the binary format triangulation and .flt for the ASCII format triangulation. This file format is set in Configure->Takeoff. The subgrade zones are defined in the Define Layer Target/Material/Subgrade command. If there aren't any subgrade zones for the Design surface, then the design after subgrades surface will be the same as the initial design surface. The topsoil replacement depths and areas are set with the commands in the Topsoil Removal/Replacement sub-menu. The topsoil replacement areas will lower the design surface by the topsoil depth to leave room for the topsoil replacement. If there aren't any topsoil replacement areas, then the design after subgrade and topsoil surface will be the same as the design after subgrade surface.

Before running this command, the layer names for the entities on the Design layer target must be set in the Define Layer Target/Material/Subgrade command. Also these entities must be at their proper elevations. The entity elevations can be reviewed using commands from the Inquiry menu and the elevations can be assigned if needed using command from the Elevate menu. Another prerequisite is that the Boundary Polyline must be set for the site.

When the program finds errors in the existing entities, a Data Error Log dialog reports these errors. Refer to the Make Existing Surface command for more information on the Data Error Log dialog.

**Keyboard Command:** mk_final_tin  
**Prerequisite:** a boundary polyline and elevated entities on the Existing layer target

---

**View Overexcavate Surface**

Use this command to view the current overexcavate surface. The Takeoff 3D Viewer will display the 3D faces of the adjusted surface. Shade the 3D model and adjust its perspective to view a rendered display. The surface that is displayed will depend on the latest surface created using the make and adjust routines.

**Prerequisite:** an overexcavate surface  
**Keyboard Command:** cube_overx

---

**Make Overexcavate Surface From Strata**

This command sets the Overexcavate surface to a selected strata surface. Before running this command, the strata surface must be created with the Make Strata Surfaces command in the Drillhole menu. The resulting overexcavate surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

[Select Strata To Process dialog box]

**Prerequisite:** Strata surfaces  
**Keyboard Command:** overx_by_strata

---

**Make Overexcavate Surface From Screen Entities**

This command makes the overexcavate surface from entities on the layers defined as Overexcavate in the Define Layer Target/Material/Subgrade command. The resulting surface of Make Overexcavate Surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

**Prerequisite:** overexcavate entities  
**Keyboard Command:** mk_overx_tin

---

Chapter 9. Takeoff Module
Make Overexcave Surface From Existing/Design Surfaces

The Initialize Overexcavation Surfaced dialog box shown here allows the user to select which surface model to overexcavate and to enter in the depth value for the desired adjustment. Use the Min Existing/Design option to set the overexcavate as the minimum of the existing and design surfaces. If a single surface is selected the value entered will be applied to that surface only. The resulting surface of Make Overexcavate Surface is stored in a triangulation file that is named with "-ox" appended to the current drawing name.

Prerequisite: Existing and/or Design surfaces
Keyboard Command: set_overx

Adjust Overexcavate Surface

This command adjusts the overexcavate surface vertically within the selected perimeter polylines. This command allows the site to be overexcavated at a variety of depths in specified areas represented with CLOSED polyline boundaries. Select the desired areas to be adjusted when prompted at the command line.

Keyboard Command: adjust_overx
Prerequisite: an overexcavate surface

Draw Overexcavate Surface 3D Faces

Use this command to draw the 3D faces of the overexcavated surface model on the screen. The 3D faces will be drawn in the TK_OVERXSURFACE layer and will depend on the latest surface created using the make and adjust routines.

Prerequisite: An overexcavate surface
Keyboard Command: draw_overx

Erase Overexcavate Surface 3D Faces

Use this command to remove the previously drawn 3D Faces from the screen.

Prerequisite: 3D Faces
Keyboard Command: erase_overx

Draw Overexcavate Cut Color Map

Use this command to display a cut color map on the screen that shows the areas of overexcavate cut. The colors will graduate from white to red based on zero cut depth to maximum cut depth. This command also offers the user to place a legend of the cut depths on the screen. Pick the desired location and type the desired scale of the legend when prompted at the command line.
Prerequisite: An overexcavate surface
Keyboard Command: overx_cfm

Erase Overexcavate Cut Color Map
Use this command to remove the previously drawn Cut Color Map and Legend from the screen.
Prerequisite: An overexcavate cut color map
Keyboard Command: overx_cfm2

Clear Overexcavate Surface
Use this command to remove the overexcavate surface. When the overexcavate surface is removed, the rest of the Takeoff commands will not calculate overexcavate volumes. You will be prompted to confirm before the remove is done.

Pulldown Menu Location: Takeoff > Overexcavate Surface
Prerequisite: An overexcavate surface
Keyboard Command: clear_overx

Make Top Surface
From Existing/Design Surfaces
This command sets the top Overexcavate surface (dwgname-rm.tin) that will be compared to a bottom Overexcavate surface for removal volumes. In the below dialog, Existing and Design surfaces created in Takeoff can be used as the top Overexcavate surface. Min Of Existing/Design is the minimum, or lowest grade, between the Existing and Design surfaces. Adjustment Depth allows you to drop either the Existing or Design surface by a specified amount.

Prerequisite: an existing or design surface
Keyboard Command: set_rm_top

From Triangulation Surface File
This routine allows a previously created surface .tin or .flt file to be loaded as the top Overexcavate surface.

**Prerequisite:** a previously created surface .tin or .flt file  
**Keyboard Command:** rm_top_file

### From Screen Entities

This command will create the top Overexcavate surface from entities in the plan view. Entities will need to have elevation such as contours, 3D faces, or elevated polylines.

**Prerequisite:** screen entities with elevation  
**Keyboard Command:** mk_rm_top

### Make Removal Surface

This command makes the triangulation models for the Removal Surfaces. The surface is automatically named as "filename-removalname.tin". The "filename" is set to the name of the current drawing (dwg) file. The "removalname" is determined by the Removal Area current in the Removal Manager. Before running this command, you must have a current Removal Area with elevated entities. Another prerequisite is that the Removal Boundary must be set for the site.

**Keyboard Command:** mk_rm_overx  
**Prerequisite:** Removal Entities and a Removal Boundary

### View Top Surface

This command allows you to view the top Overexcavate surface in 3D mode.
In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface (the shading is shown in the above drawing). The arrow icon reports the elevations at the bottom of the screen as you move around the surface.

The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: a top Overexcavate surface

Keyboard Command: cube_rm_top
**Draw Top Surface 3D Faces**

This command will display the top Overexcavate surface as 3D faces in the plan view.

**Keyboard Command:** `draw_rm_top`  
**Prerequisite:** Make Top Surface  
This command will erase the plan view entities created in Draw Top Surface 3D Faces.

**Keyboard Command:** `erase_rm_top`  
**Prerequisite:** Draw Top Surface 3D Faces

---

**Removal Settings**

This command sets the layers suffixes for the entities created in the commands Draw Removal Surface and Draw Removal Contours. These Surfaces are added to the Removal Area names. For example, if Topo2 is set to Current in the Removal Manager, Draw Removal Surface will create 3D faces on the layer Topo2\_TIN. Likewise, Draw Removal Contour will create contours on the layer Topo2\_CONTOUR. The interval that the contours are drawn are also set here.
Removal Manager

In Removal Manager command every Removal Area in a project and the entities that define them is displayed as well as the Centroid (center coordinate) for that Area. Add allows you to name and create a new Removal Area. Remove will delete the Removal Area. When a Removal Area is set to Current, it will be used by other Removal commands when processing.

![Removal Manager Window](image)

Import Removal Text ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. The points brought in with this command will be assigned to the Current Removal Area if Draw Points is set to Points or Field-to-Finish. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters.
Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File. Special formats can be directly imported by choosing that File Format at the top of the dialog.

**Prerequisite:** Text/ASCII File and a Removal Area created and set to Current

**Keyboard Command:** `rm_overx_mg`r

### Draw Removal Field to Finish

This command turns data collector field notes into Removal Area points and linework by matching the descriptions of the field points with user-defined codes. Two files are used in Field-to-Finish - a coordinate file and a field code definition file. For more on these files and their settings see Draw Field-to-Finish under Survey.

**Keyboard Command:** `rm_overx_f2f`

**Prerequisite:** A data file of points with descriptions and a Removal Area created and set to Current

### Draw Removal Breakline

This command allows you to draw 3D linework for the Current Removal Area.
The Show Options on Startup dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

Prompt for Elevation/Slope controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

Use Surface Model from File will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

There are 3 options under Auto-Zoom Mode. Never will not zoom to the last point picked. Proximity will zoom to the percent proximity set below. Always will always zoom center on every point.

If the Proximity Auto-Zoom mode is checked, the percent of the proximity is set in the Proximity Zoom Level% box.

**Keyboard Command:** rm_overx_3dp  
**Prerequisite:** a Removal Area set to Current

### Removal Entities

#### Tag Removal Entities

This command allows the user to select polylines and points that define the Current Removal Area. Carlson Takeoff will separate each Removal Area in the Calculate Removals Volumes Report.

**Prerequisite:** linework and/or points intended for the Current Removal Area  
**Keyboard Command:** tag_rm_overx

#### ID Removal Entities

This command allows users to identify Removal Entities by either picking on a polyline(s) or by searching the entire drawing. The command will then highlight the polyline in the plan view.

**Prerequisite:** Tag Removal Entities  
**Keyboard Command:** id_rm_overx

### Untag Removal
This command allows the user to remove previously tagged Removal Entities.

**Prerequisite:** Tag Removal Entities

**Keyboard Command:** `untag rm_overx`

---

**Set Removal Boundary**

Use this command to select the "CLOSED" polyline that defines the outer most limit of the Current Removal Area. This boundary should dissect the site at the point where the Current Removal Entities end. Volume calculation will take place inside this boundary.

**Prerequisite:** a closed polyline

**Keyboard Command:** `rm_overx_perim`

---

**Draw Removal Surface**

This command draws the current Removal Surface as 3D faces in the plan view.

**Keyboard Command:** `draw rm_overx_tin`

**Prerequisite:** Make Removal Surface

---

**Draw Removal Contours**

This command displays all the contours that represent current Removal Surface. They are created off of the Removal Area .tin model. For contour interval, see Removal Settings.
**Keyboard Command:** draw_rm_overx_ctr  
**Prerequisite:** Make Removal Surface

---

**Calculate Removals Volumes**

This command reports the volumes in cubic yards for each Removal Area against the Top Removal Surface. The volumes are given for each area as well as a total for all the areas. Calculate Removal Volumes then creates and reports a Composite Surface against the Top Removal Surface taking the lowest grade in overlapping Removal Areas.

---

From the Standard Report Viewer, you can Save, Print, or place on the Screen the volume numbers. You can also type your own text into the report.

**Keyboard Command:** calc_rm_overx  
**Prerequisite:** Make Top Surface and Make Removal Surface
Surface Manager

This command allows the user to name and manage multiple surface models. The Surface Manager dialog shown here has options to name and save the current "existing and design" surface models. The "current" surface is dictated by the layers that populate a target and the Make Surface command. If layers are removed from a target, and others assigned, multiple surfaces can be created and stored. When the Lock Status is check, the Current Surface will remain current even if you run Takeoff > Make Existing Ground Surface or Make Design Surface. If the Lock Status is uncheck, then Making the Existing or Design Surface will become the current surface, overriding the current surface selected in the Surface Manager. Highlight a named surface and select the Set Current From List option to make that model active. Use the Remove From List option to remove a named surface model from the list.

Selecting the Save Current To List options brings up the Surface Name dialog box shown here. Type the desired name that describes a particular surface model and select OK.

Pulldown Menu Location: Takeoff > Surface Tools
Prerequisite: none
Keyboard Command: surf_mngr

Make User Defined Surface

This command makes a surface from the entities on the layers defined as user-defined targets in the Define Layer Target/Material/Subgrade command. The purpose of user-defined surfaces is for modeling surfaces besides existing ground and design. The drawing needs to contain entities that represent the elevations of the user-defined surface. For example, the user-defined surface could be for alluvial soil and the drawing has contour polylines for this surface.
There is a dialog to select which surface to make. The surface is stored in a triangulation file that is named after the current drawing name with the user-defined surface name appended.

This user-defined surface can be applied to Takeoff routines by running the Set Active Surfaces command.

**Pulldown Menu Location:** Takeoff > Surface Tools  
**Prerequisite:** Define Layer Target/Material/Subgrade command  
**Keyboard Command:** mk_user_tin

### Triangulate and Contour

This command provides all of the functionality related to contouring and creating tin surface models in one routine. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

*Triangulate & Contour* has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force *Triangulate & Contour* to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3d polylines and lines with elevation are be treated as breaklines.

**Triangulate Tab**
Draw Triangulation Lines

When this option is turned on, the program will draw the triangulation as 3D lines. Specify the layer for these lines in the box to the right.

Draw Triangulation Faces

When this option is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD's modeling routines such as HIDE and SHADE or in routines such as 3D Viewer Window, 3D Surface FlyOver and Slope Zone Analysis. Specify the layer for these 3DFaces in the box to the right.

Store Surface Data

This option names and creates a surface or surfaces that are associated with the drawing. The creation of a surface is necessary in order for the Surface Tools to function. A Triangulation file must also be specified before using the Store Surface option.

Write Triangulation File

This option stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file/s can be used by several commands such as Volumes By Triangulation, Spot Elevations, and Profile from FLT File. Either type in the file name to create or press the Browse button to select a file name.

Use Inclusion/Exclusion Areas

When this box is activated, the program will later prompt you for inclusion and exclusion polylines which are used to trim the contours. The inclusion and exclusion polylines must be closed polylines and must be drawn before starting Triangulate & Contour. Only the parts of the contour lines that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings.

Ignore Zero Elevations

---

Chapter 9. Takeoff Module

1935
When activated, this setting will filter out all data points at an elevation of zero from the data set.

**Erase Previous Contour Entities**

When activated, this setting will erase previously drawn contour entities.

**Specify Elevation Range**

The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval. If you would like to manually set the range over which to contour, select this option.

**Pick Reference Plane**

The triangulation network is based on the x,y position of the points. This option allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the Viewpoint 3D command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines**

This option highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys**

This option creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3d polylines along ridges and valleys.

**Interpolate Summits and Pits**

This option creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

Before: Surface made from an existing contour map. Note the flat spots in the bottom of the valley when Interpolate Ridges and Valleys is disabled.

![Before Example](image)

After: The same surface with Interpolate Ridges and Valleys enabled.
Max Triangle Mesh Line Length

This value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The Exterior value applies to triangulation lines around the perimeter of the triangulation area and the Interior value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

Error Log

The following dialog box appears when the Triangulate & Contour routine finds a conflict between breaklines or other surface entities. The type of conflict is identified, and when an item is chosen, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Crossing Breaklines indicates that the intersection of two entities has two differing elevations. Vertical Edges indicates that two entities or vertexes of differing elevations have the same xy location, thus forming a vertical plane.
Contour Tab

Draw Contours
When this box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

Contour by Interval or Contour an Elevation
Select whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows
you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100.
The default mode is by interval.

**Contour Interval**
Specify the interval to contour. Note: If the above option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

**Minimum Contour Length**
Contour lines whose total length is less than this value will not be drawn.

**Reduce Vertices**
This option attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON

**Offset Distance**
When the Reduce Vertices option is enabled, This value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

**Hatch Zones**
When activated, this option will allow you to hatch the area between the contours sequentially. A secondary dialog will load allowing the user to specify the hatch type and color.

**Draw Index Contours**
This option creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

**Contour Smoothing Method**
Select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

**Bezier Smoothing Factor**
The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect.

**Subdivisional Surfaces / Subdivisions Generation**
This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance's sake, consider enabling Reduce Vertices.

**Labels Tab**
Label Contours
When activated, contours will be labeled based on the settings below.

Label Layer
Specifies layer name for intermediate contour labels.

Index Label Layer
Specifies layer name for index contour labels.

Label Style
Specifies the text style that will be used for the contour label text.

Label Text Size Scaler
Specifies the size of the contour labels based on a multiplier of the horizontal scale.

Min Length to Label
Contours whose length is less than this value will not be labeled.

Break Contours at Label
When checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

Draw Broken Segments
When checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

Label Contour Ends
When checked, contour ends will be labeled.

Draw Box Around Text
When checked, a rectangle will be drawn around contour elevation labels.

Label Index Contours Only

When checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

Hide Drawing Under Labels

This option activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour is fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, and the contour lines themselves remain contiguous. This feature will also hide other entities that area in the immediate vicinity of the contour label.

Align Text with Contour

When checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

Align Facing Uphill

When checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the bottom of the text label will always be toward the downhill side of the contours. So as the labels are read right side up, you are always facing uphill.

Internal Label Intervals

Choose between label intervals or distance interval. Label intervals will label each contour with a set number of labels. Distance interval lets you specify a distance between labels.

Selection Tab
Specify Selection Options

When checked, this allows you to control what type of entities Triangulate & Contour uses. Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard AutoCAD entities types. Spot/Bottom Elevation Inserts include text entities that start with 'X'. From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file.
Contours without triangulation network. The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pull-Down Menu Location:** Tools-> Surface Tools  
**Prerequisite:** Data points of the surface  
**Keyboard Command:** tri
This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

Load TIN File: Allows you to specify a triangulation (.flt or .tin) file to load.
Load DXF File: Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.
Select 3D Faces: Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.
Pick Bounding Polylines: Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.
Fast TIN Intersect: When checked, this command will not try and intersect 3DFACE entities.
Fill-in-holes: When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to set before loading the TIN file to take effect.

Next: Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you
do not specify any perimeters, the desired operation/s will be performed on the entire TIN.

**Elev-Value:** Specify either an elevation or value depending on the operation. The value specified will be used for subsequent operations.

**Set New Elevation:** Sets all TIN faces in the subject area to the elevation specified in the Elev-Value field.

**Set NULL’s to Elevation:** Sets all NULL values in the subject area to the elevation specified in the Elev-Value field.
Set Elevation's to NULL: Sets all of the elevation values in the subject area to NULL.

Set Elevation by Surface: Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

Add: Adds the value specified in the Elev-Value field to the subject area of the TIN.

Subtract: Subtracts the value specified in the Elev-Value field to the subject area of the TIN.

Multiply: Multiplies by the value specified in the Elev-Value field to the subject area of the TIN.

Divide: Divides by the value specified in the Elev-Value field to the subject area of the TIN.

Offset: Performs a perpendicular offset of the TIN surface by the specified amount.

Tolerance: This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

Simplify: Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

Add TIN: Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

Subtract TIN: Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

Min TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

Max TIN: This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

Join TIN: Merges the existing subject TIN into a second user selected TIN file. The subject TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file.

Insides: If this is the only option checked, only changes made within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved.

Border:

Outsides: If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved. Everything outside of the perimeter will be saved.

SaveAs TIN: Saves the current TIN as an .flt or .tin file.

SaveAs DXF: Saves the current TIN as a DXF file. This format can be used by many other CAD programs.

Draw As 3DFaces: Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.
This icon converts the right mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out. This icon converts the right mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis. This icon converts the right mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes. This icon toggles shading on and off. This icon restores the graphics to plan view. This icon reverses the effects of all operations performed on the TIN and reverts it back to its original status. This icon exits the routine. If the TIN has been modified, you will be prompted to save.

Pull-Down Menu Location: Tools-> Surface Tools
Prerequisite: 3D Faces, a TIN file or a DXF file.
Keyboard Command: TINUTIL

Volumes By Triangulation

Volumes By Triangulation is an alternative volume method that compares two triangulation networks. This method is different from the grid based volume routines (Stockpile Volumes, etc.) and the cross section volume routine (Calculate Section Volume). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismsoidal volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 foot to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .flt files that are created by Triangulate & Contour with the Write Triangulation File option. Before using this command, run Triangulate & Contour twice to create an triangulation (.TIN) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

Prompts

Select EXISTING surface Tmesh File Choose a .tin file
Select FINAL surface Tmesh File Choose another .tin file
Pick inclusion perimeter polyline (ENTER for none): pick a closed polyline perimeter
Calculating ...
Write report to file (Yes/<No>)? Press Enter
Write report to printer (Yes/<No>)? Press Enter
Comparing Triangulation files: C:\SCADXML\DATA\TRI1.FLT
and C:\SCADXML\DATA\TRI2.FLT
Cut volume: 66891.35 C.F., 2477.46 C.Y.  
Fill volume: 43458.01 C.F., 1609.56 C.Y.  

**Pull-Down Menu Location:** Tools-> Surface Tools  
**Prerequisite:** Two .tin files.  
**Keyboard Command:** trivol  

---  

**Calculate Stockpile Volume**

This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is above the perimeter elevation, such as in the case of a stockpile of material. The complimentary command, **Calculate Pond/Pit Volume**, is for the opposite situation, in which the entire volume to be calculated is below the elevation of the perimeter.

The program internally computes base and final grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select another 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation. Additional 3D polylines can also be specified to more precisely define the base surface. These must be on the BASE_BREAKLINE layer to be used for this purpose. These can be generated by the **Draw 3D Poly Base Breakline** routine.

The final surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASE_BREAKLINE polylines.

You have the option of setting the resolution of the grids.

**Prompts**

- **Material density lbs/ft³ (Enter for none):** enter a material density in lbs per cubic foot, or press Enter for none
- **Ignore Zero Elevations [<Yes>/No]?**
- **Select stockpile entities and perimeter.**
- **Select objects:** pick the objects that define the stockpile and the 3D polyline perimeter
- **Select stockpile perimeter polyline:**

![Make 3D Grid File dialog](image)

**Make Grid File dialog** Set the resolution and then click OK.
Volume report
Lower left grid corner: 15965.45,12657.05
Upper right grid corner: 16269.40,12906.29
X grid resolution: 50, Y grid resolution: 50
X grid cell size: 6.08, Y grid cell size: 4.98
Stockpile volume: 1191674.87825 cubic ft, 44136.107 cubic yards

Stockpile defined by points and a 3D polyline perimeter
Window these objects to obtain the volume report

Keyboard Command: stockvol
Prerequisite: Data representing the stockpile surface and a 3D polyline representing the perimeter of the stockpile.

Calculate Pond/Pit Volume
This command is a customized and simplified method for calculating volumes in a situation in which the entire volume to be calculated is below the perimeter elevation, such as in the case of a pond or pit. The complimentary command, Calculate Stockpile Volume, is for the opposite situation, in which the entire volume to be calculated is above the elevation of the perimeter.

The program internally computes base and final grid surfaces from drawing geometry. The base surface is calculated from a 3D polyline representing the perimeter of the area being analyzed. If that 3D polyline is drawn on the PERIMETER layer, the command will automatically detect and use it. If no 3D polyline is found on that layer, you have an opportunity to manually select another 3D polyline to use. The 3D polyline perimeter can be drawn with the Draw 3D Polyline Perimeter command before using this routine.

The 3D polyline perimeter is also used as the inclusion perimeter for the volume calculation.
Additional 3D polylines can also be specified to more precisely define the base surface. These must be on the BASEBREAKLINE layer to be used for this purpose. These can be generated by the Draw 3DPoly Base Breakline routine.

The final surface is calculated from all of the other selected drawing entities such as points, line, inserts, and polylines, along with the perimeter polyline, but not including the BASEBREAKLINE polylines.

You have the option of setting the resolution of the grids.

Prompts
Ignore Zero Elevations [<Yes>/No]?
Select Pond/Pit entities and perimeter.
Select objects: pick the objects that define the surface and the 3D polyline perimeter
Select Pond/Pit perimeter polyline:

Make Grid File dialog Set the resolution and then click OK.

Keyboard Command: pitvol

Prerequisite: Data representing the pond/pit surface and a 3D polyline representing the perimeter of the pond/pit.

Set Active Surfaces
This command assigns which surfaces to use for initial and final. These surfaces are used by all the Takeoff routine that compare surfaces including:
- Calculate Total Volumes
- Calculate Volumes Inside Perimeter
- 3D Drive Simulation
- Cut/Fill Contours/Labels/Color Map
- Surface Inspector
- Quick Profile
- etc.

The surface created by the Make Existing Ground Surface command is called "Existing" and is the default for the Initial Surface. The surface created by the Make Design Surface command is called "Design" and is the default for the Final Surface.

The purpose of this routine is for selecting user-defined surfaces to use in place of the existing ground or the design surface. For example, there could be a user-defined surface for alluvial soil that is set as the initial surface while design is set to the final surface. Then the calculate volume routines will report the quantities between alluvial soil and design. Also the Display->Cut/Fill Color Map routine will make the map for the difference between the alluvial soil and design surfaces.

These user-defined surfaces can be created using the Add Target function in the Define Layer Target/Material/Subgrade command combined with the Make User-Defined Surface command.
Prerequisite: a surface model
Keyboard Command: set_active_tins

Design Surface Vertical Offset
This command can be used to lower or raise the design surface within a defined perimeter or by the entire surface.

Prerequisite: a design surface
Keyboard Command: adjust_final

Existing Surface Vertical Offset
This command can be used to lower or raise the existing surface within a defined perimeter or by the entire surface.

Prerequisite: an existing surface
Keyboard Command: adjust_exist

Merge Existing With Design
This command allows you to merge the existing surface with design surface within perimeter polylines. The resulting merged surface can be saved to update either the Existing or Design surfaces. The program prompts for inclusion and exclusion perimeter polylines. These polylines must be closed. The merge will be applied inside the inclusion perimeters and not inside the exclusion perimeters. The exclusion perimeters are optional.

For example, if a portion of the site is completed, you can update the existing surface to match the design for the completed area. First, draw a closed polyline around the completed area. Then run Merge Existing With Design and choose the merge results target as Existing. Then select the perimeter polyline.

Pulldown Menu Location: Takeoff > Surface Tools
Prerequisite: existing and design surfaces and an inclusion perimeter polyline
Keyboard Command: merge_final

Calculate Total Volumes
Use this command to report total volume calculations within the site boundary polyline. The report includes the cut and fill quantities, slope and horizontal area, average and max strata cut depth and max cut/fill depths and locations. Also in the report, strata and topsoil quantities if the site has strata and topsoil defined. Besides reporting the total quantities for the site boundary, Area Of Interest polylines can be used to report quantities within named perimeters.

Before running this command, the existing and design surfaces must be created and the boundary polyline must be assigned. Also, the strata surfaces, topsoil and Area Of Interest polylines need to be set before this command if those features are to be reported.

The Volume Options dialog box shown here offers options for the final report. Here you can select four different types of reports: Standard Report Viewer, Custom Report Formatter, Expanded Auto Format, and Compressed Auto Format. The Cut Swell Factor is multiplied by the cut volume and the Fill Shrink Factor is multiplied by the fill volume. Report Cut/Fill Depth Zones breaks the Cut/Fill volumes up by user-defined depth
intervals. The Report Units setting chooses between English and Metric quantities for the report. In Drawing Setup in Takeoff, you set the drawing units as either English or Metric. The Report Units will default to match the drawing units but you can change the Report Units to the other mode and the program will apply the conversion between English and Metric for the report. So you can have a drawing in English units and create a report with Metric quantities.

Note: As the quantities are calculated within each area, the area is hatched with a solid fill as a visual verification that the right area is being processed.

Shown here is an example of a Standard Report Viewer.
Use Customs Report Formatter to customize or “user define” the reporting options. The Report Formatter Options dialog box shown here offers a variety of output options including Excel. You can choose the fields to report from the Available list and set their report order under the Used list.

The Expanded Auto Format is shown in this DWF preview.
If drillholes have been located on the drawing and strata types and depths have been defined, a calculate Strata Depth Zones Volume option becomes available. Here strata volumes are broken down by user-specified depth intervals. The depths are either determined horizontally (By Level) or by the area of the deepest cut (By Zone Area).
Shown here is an example of the report if strata depth intervals have been defined.

The Balance Cut/Fill option shown here allows an import or export volume in cubic yards option. Use these options if waste material is available or needed elsewhere. If this option is used the resulting report indicates the vertical movement of the site needed to satisfy the balance option.

Shown here is a report with a 500 CY importation of material and suggests that the site be vertically raised 0.859 feet.
If the adjusted surface is satisfactory, Carlson Takeoff offers the option to save the adjusted surface as shown here in the Balance Cut/Fill dialog box.

**Pulldown Menu Location:** Takeoff

**Prerequisite:** Existing and design surfaces and a boundary polyline

**Keyboard Command:** tin_volume

### Calculate Volumes Inside Perimeter

Use this command to create volume reports inside the selected closed perimeter polyline. The same reporting options are available for this command as are for the Calculate Total Volumes command.

**Keyboard Command:** tin_volume2

**Prerequisite:** Existing and Design surfaces and a closed perimeter polyline

### Draw 3D Poly Perimeter

This command draws a 3D polyline in the PERIMETER layer. This polyline is required by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines. In these routines, this polyline is used as the inclusion perimeter for volumes. You may want to set your AutoCAD Object Snap prior to running this routine so that you obtain the elevations of existing points while creating the 3D polyline.

**Prompts**

Select the 3Dpolyline options you want and press enter.

**Command:** 3dperim

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: (Pick)
Interpolate/screen Pick/<Elevation> <0.00>: 818
Z: 818.00

Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 814
Z: 814.00, Hz dist: 60.64, Slope dist: 60.77, Slope: -6.6% Ratio: -15.2:1

Slope/Ratio/Interpolate/Degree/screen Pick/<Elevation> <0.00>: 815
Z: 815.00, Hz dist: 26.32, Slope dist: 26.33, Slope: 3.8% Ratio: 26.3:1

Pull-Down Menu Location: Tools-> Surface Tools
Keyboard Command: 3dperim
Prerequisite: None

**Draw 3DPoly Base Breakline**

This command draws a 3D polyline in the BASE_BREAKLINE layer. This polyline is used by the Calculate Stockpile Volume and Calculate Pond/Pit Volume routines to model the base surface. You may want to set your AutoCAD Object Snap prior to running this routine so that you obtain the elevations of existing points while creating the 3D polyline.

**Prompts**

Select the 3Dpolyline options you want and press enter.

command: 3DBASE

Structural/Close/Direction/Extend/Options/<Pick point or point numbers>: (Pick)
Interpolate/screen Pick/<Elevation> <0.00>: 818
Z: 818.00

Structural/Close/Direction/Extend/Options/<Pick point or point numbers>: (Pick)
Interpolate/screen Pick/<Elevation> <0.00>: 814
Z: 814.00, Hz dist: 60.64, Slope dist: 60.77, Slope: -6.6% Ratio: -15.2:1

Structural/Close/Direction/Extend/Options/<Pick point or point numbers>: (Pick)
Interpolate/screen Pick/<Elevation> <0.00>: 815
Z: 815.00, Hz dist: 26.32, Slope dist: 26.33, Slope: 3.8% Ratio: 26.3:1

Pull-Down Menu Location: Tools-> Surface Tools
Prerequisite: None
Keyboard Command: 3dbase

**Material Quantities**

The Material Quantities flyout shown here offers many options for quantity reporting including the option for user defined attributes. Entities with attributes can be drawn, edited, and identified. Standard and custom report options are also available.

Material Quantities are counted from the entities in the drawing. Several entity properties can be reported including entity count, length, area and volume. Also user-defined attributes can be assigned to the entities and reported. The type of material for each entity is determined by the layer for the entity. In the Define Layer Target/Material/Subgrade, you can assign the material types by layer.
Standard Report

Use this command to display all or a selected set of material quantities and user-defined information with the standard Carlson Takeoff report format shown here.

![Material Quantities Report]

**Prerequisite:** Defined materials  
**Keyboard Command:** materials_report2

Custom Report

Use this command to customize or "user define" the reporting options. This command first prompts whether to report quantities for all the entities in the drawing or selected entities. Then if the drawing contains Areas Of Interest polylines, there is an option report quantities by these areas which adds the area name to the available report fields to allow sorting and grouping by area name. The Report Formatter Options dialog box shown here offers a variety of output options. You can choose the fields to report from the Available list and put them in report order under the Used list.
Selecting the Display option shows the report in the standard Carlson Takeoff report viewer. Reports can be exported to an Excel spreadsheet as well.

**Prerequisite:** Defined materials  
**Keyboard Command:** materials_report

### Define Materials Library

Define Materials Library allows you to Add, Remove, Load, Save, and Report a list of material costs. Costs can be set per area, count, volume, ton, or length by using the Edit function at the bottom of the dialog. The left side of the dialog can be used to set categories for different material costs. Material costs can also be Imported from user-specified text files (.txt, .dat, or .csv).
Prerequisite: pricing for materials

Keyboard Command: define_tk_materials

## Edit-Assign Block Materials

This command scans the current drawing to find and report block/symbol names and their count. For example, when the drawing contains different symbols for different types of utilities, this command identifies each type of symbol and the number. From this command, you can set the Description and Cost of the block by using the Edit button. You can also set the Description and Cost by predefined Materials by using the Set By Library button. When a block name is highlighted from the list, the drawing is zoomed to the location of one of those blocks so that you can see what it looks like. To Report these materials as part of the Standard Report, check on Include Materials Quantities Report in the Edit Materials dialog of the block layer found in the Define Layer Target/Material/Subgrade command. You can also just click on the Report button for a simple report.

Prerequisite: Blocks

Keyboard Command: edit_all_blocks

## Define Material Attributes

Use this command to define all the material attributes that will be assigned to objects in the drawing for reporting...
purposes. The Define Attribute dialog box shown here allows the user to "Add", "Edit", or "Remove" attributes and save the definitions for later use. Simply "Load" a saved attribute definition file with the "tkd" extension for future use.

Selecting the Add or Edit options produce the edit attribute dialog box shown here. Use this command to define the Data name and the layer the objects currently reside on and the layer that future objects will be drawn on. Two entity types can be used, polyline data or point data. If the symbol option is selected the user has the option of which symbol will represent the object. Attribute fields must be defined for material reporting.

Selecting the Add or Edit button on the Edit Attribute dialog box brings up the Edit Field dialog box shown here. Use this dialog to define the field name and type. If the Value option is selected, only numeric values will be
allowed when prompted. If the String option is selected, the user will have the ability to type in a text message when prompted.

![Edit Field](image1.png)

**Prerequisite:** attributes  
**Keyboard Command:** define_tk_data

**Draw Materials Entities**

Use this command to apply attribute data to objects as you draw or digitize them. Select the predefined attribute type to draw from the list available in the Select Attribute to Draw dialog box shown here.

![Select Material Entity To Draw](image2.png)

The command line will prompt the user to pick the points of the desired location of the object and allow the attribute data fields to be filled out upon completion or each "enter".

**Prerequisite:** defined attributes  
**Keyboard Command:** draw_tk_data

**Input-Edit Material Attributes**

Use this command to assign predefined attribute information to an object already existing in the drawing. The command line prompt will require the user to select the object that attribute information is to be applied, and offer the Input-Edit Attribute dialog box shown here. This dialog box will display all predefined fields for that particular attribute type.
Prerequisite: predefined attribute information
Keyboard Command: edit_tk_data

Identify Materials Entities

Use this command to display all the objects that have attribute data assignments. The user will have the options of selecting the objects by picking them individually or by searching the entire drawing database. The objects that have attribute information assignments will "highlight" on the screen and the command line will display the attribute information.

Prerequisite: attributes
Keyboard Command: id_tk_data

Tools Menu

3D Drive Simulation

This command allows you to view and move around the design surface in 3D mode.
Use the arrows on your keypad to move around the drawing.

At the very bottom of the window you will find the basic commands: Run will start to drive your vehicle around the surface, once your vehicle is moving the Run button turns into the Stop button. The arrows moves your vehicle left and right. The magnify glass zooms in and out. Click and drag up to zoom in and click and drag down to zoom out. When your vehicle is stopped the icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis.

The hand icon allows you to pan around the viewer. Click and drag the direction you want to move. The icon toggles the shading of the surfaces. The icon exits 3D Driver Simulation.

Above the basic command buttons you can change the Elevation and Distance away from your vehicle. Also, you can set the speed at which your vehicle travels. For a smaller drawing you may want to move around slower, for a larger drawing faster. Note: Unrealistic speeds such as 500 mph in a dozer may cause 3D Drive Simulation to freeze.

View Direction: Sets the direction of the view from the Front, Back, Left, or Right.

Vehicle Icon: You can select which Vehicle you want to use whether: Dozer, Hummer, School Bus or none at all.

View Position: Sets the elevation and distance to either that of the driver, a pedestrian, or bird.

Shading: Here you can set the shading of the surface to either Flat, Smooth, Elevation, Cut/Fill, or none. Flat just shades the contours as the are. Smooth smooths contours to look for realistic. Elevation colors different elevations in different colors so differences can visual be seen. Cut/Fill colors areas of cut differently than areas of fill so they can be visually seen. None merely shows the triangulation.and does not shade in a surface.

You can select the Surface, High, and Low color by enter in an AutoCAD defined color number or you can choose Select to pick a color. The circle on the right determines the shade of the color.

In the top right of the 3D viewer is an aerial map of your surface. Below that the Elevation, Slope percentage, Azimuth, and Roll are updated as your vehicle moves around the surface. Slope and Roll are shown visually here as well.

On the bottom right you can set the Vertical Scale and check to Ignore Zero Elev, Display Trail, and Display Cut/Fill. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Display Trail draws a line where your vehicle has driven. Display Cut/Fill displays the cut and the fill.

**Prerequisite:** a design surface

**Keyboard Command:** tk_flyby

**Existing Surface 3D Viewer**

This command allows you to view the existing surface in 3D mode.
In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface. The arrow icon reports the elevations at the bottom of the screen as you move around the surface. The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

**Prerequisite:** an existing surface

**Keyboard Command:** cube_exist

---

*Chapter 9. Takeoff Module*
Design Surface 3D Viewer

This command allows you to view the design surface in 3D mode.

In the top right of the control bar you can check to Ignore Zero Elev and Color By Elevation and change the Vertical Scale. If you increase the Vertical Scale than elevation differences can be seen easier. Ignore Zero Elev does not display elevations of zero in the 3D viewer. Color By Elevation shows elevation change with the change of colors. Note: Color By Elevation is used in the above example. To adjust the color use the color circle on the right.

The magnify glass icons can be used to zoom in and out. Click on the plus magnify glass to zoom in and the minus magnify glass to zoom out. With the icon click and drag up to zoom in and drag down to zoom out. The hand icon below the color circle allows you to pan around the viewer. Click and drag the direction you want to move. The icon can be used to rotate the vantage point of the viewer by the x, y, or z axis. When you move the cursor to the screen it will change into a x, y symbol or a z symbol. Move the cursor around to move it from one to the other. If you have the x, y cursor move right or left to change the x axis view, or to change the y move the cursor up or down. If you have the z cursor than move it in a circular fashion to rotate the view point according to the z axis. The icon toggles on and off the shading of the surface (the shading is shown in the above drawing). The arrow icon reports the elevations at the bottom of the screen as you move around the surface.

The icon restores the surface viewpoint to flat. The icon exits 3D Driver Simulation.

Rotation Axis: These three control bars rotate the surface around the x, y, and z axis. Clip plane trims the size of the surface shown in the viewer.

Prerequisite: a design surface

Keyboard Command: cube_design
FlyOver Along 3D Polyline

This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

**Surface model from file:** Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.

**Screen entities:** Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.

After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a "free" path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.

![3D Flight Viewer](image)

- This button raises the elevation of your viewing position.
- This button lowers the elevation of your viewing position.
- This button turns your viewing position to the left.
- This button turns your viewing position to the right.
- This button allows you to zoom in and out.
- This button allows you to rotate the main animation window in any X, Y or Z direction.
- This button allows you to pan.
- This button toggles shading on and off.
- This button starts the animation in the main window.
- This button stops.
This button exits the 3D Surface FlyOver command Control for position of the light source, viewed from above.

**Prerequisite:** Surface Model and optionally a 3D Polyline

**Keyboard Command:** flyby

### Surface Inspector

This command allows you to report and optionally label elevations from your drawing. You can analyze all of your different surface files at one time. After running the command, Surface Inspector will begin showing you real-time elevations for each surface as you move the cursor on the screen. If you pick a point or enter coordinates, the elevation will be labeled along with the surface name.

Surface inspector shows you real-time elevations as you move the cursor over your surface.

**Prerequisite:** Surface Model (s)

**Keyboard Command:** surfvals

### Surface Report

This command reports a variety of information on each of your different surfaces. This is useful for checking for bad data and the file names of your surfaces. An example is below.

**Surface Report 3/10/2005 15:34**

Max Cut: 18.327 at 409269.984,207196.674
Max Fill: 1.943 at 409389.586,207248.866

**Original Ground After Topsoil Removal**

File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-ex.flt
Design With Subgrade and Topsoil Replacement
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-fn.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Original Ground Before Topsoil Removal
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-og.flt
Date Modified: Thu Feb 10 10:02:05 2005
File Size: 64,028
Points: 259, Edges: 744, Triangles: 486
Min Z: 184.000 at 409299.790,206879.287
Max Z: 210.000 at 409571.562,207177.240

Design Without Subgrade or Topsoil Replacement
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-bs.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Design With Subgrade
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-zn.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Prerequisites: A Surface
Keyboard Command: SURF_STATS

Graphic Reports
The Graphic Report commands can be used to create .PDF files for different Profiles, Cross Sections, 3D Surfaces, and of the Plan View. Adobe Reader or Pro is required for these routines to function.

The Plan Graphic Report command creates a plan view report of the site. Isolate the layers you want to show up in the report before you run this command. The routine will zoom extents to the limits of the layers you select and fit them to the Paper Size you select.
The Title Block Setup dialog draws a border and title block for the selected sheet size. Here you can enter text you want to display in the report.

![Title Block Setup dialog](image)

Here is an example of the Plan Graphic Report.

![Plan Graphic Report](image)

The Surface Graphic Report command creates a 3D view PDF report of any surface (.tin or .flt files) created in the drawing, including existing, design, and strata surfaces. In the first dialog, select the surface you wish to see in the report. This dialog also gives you the option to view the surface as a triangulation mesh or grid. View Direction determines the orientation of the surface in the next dialog.

![Surface Graphic Report](image)
The Carlson 3D Viewer gives you the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade the lighting. When you have orientated the model to your liking, click on the Printer icon in the lower right corner of the dialog.

Here is an example of the Surface Graphic Report.
The Profile Graphic Report creates a 3D view profile of the site existing or design surface. You will first be prompted for how to create the Profile:

"Pick starting point (CL-Centerline, P-Polyline)". CL prompts you to load a previously created Centerline (.cl) file, P allows you to pick any polyline in the plan view, or you can pick two points on the screen that you want the program to create a profile through. Next, you will be prompted for Title Block settings similar in other Graphic Reports. Here is an example of the Profile Graphic Report.

The Section Graphic Report creates cross section in a single step with option to include the plan view showing the section alignment. Cross Sections can be created within the routine from Left to Right, Bottom to Top, or along any polyline in the drawing. For more control over the orientation of the cross sections, Select Files allows you to select a previously created section file (.sect).
Like many other Graphic Reports, several of the surface models (.tin or .flt) created in the job can be used in the report. Simply select the surfaces you want to see in the report (there is no limit) and at what Station Interval (in feet) you want to see them. Note: this is not an opinion when using a .sct file.

Here is an example of the Section Graphic Report.

**Pulldown Menu Location:** Tools > Graphic Reports  
**Prerequisite:** Existing and design surfaces  
**Keyboard Command:** plotplan, plotsurf, tk_quickpro, plotsct
Quick Profile

This command allows you to create, view, edit, and report profiles from the TakeOff surfaces.

Pick starting point (CL-Centerline,P-Polyline): To make a profile you need to define the alignment by: 1) picking points on the screen; 2) typing in CL in the command prompt, and selecting a centerline file; or 3) typing in P and choosing a polyline from the screen. After doing so, the above profile viewer is created.

The far right dialog box allows you to toggle on and off different Surfaces to view in the profile viewer including: Original Ground, Topsoil Removal, Design Surface, Final Subgrade, Overex Surface, Strata Surfaces. If a surface is not defined in the current TakeOff project, like Topsoil Removal in this example, than you will not have the option to display it. In this example, the three Surfaces that can be displayed, Original Ground, Design Surface, and Final Subgrade, are displayed in the profile viewer.

When you move the cursor around the profile viewer a crosshair follows along the surface and reports the Station, Slope %, and Elevation at each point. It is displayed towards the bottom-right side of the screen next to Adjust Alignment. In this example the station is 2+16.650, the Slope is -5.6%, and the Elevation is 818.133. A crosshair can been seen in the profile drawing and along the alignment in the main drawing as well.

Vertical Exaggeration: x1 is the actual appearance of the surface(s). Depending on the flatness of the surface(s), you can select x2, x5, x10 vertical exaggerations to better see the elevation differentiation and different surfaces. The option Fit automatically exaggerates the vertical to best fit the profile viewer.

Drag Action: This dialog allows you to zoom in and out, and pan around the profile. To zoom in click and drag up, to zoom out click and drag down. To Pan, click and drag the direction you want to move.

The Adjust Alignment icon allows to pick the polyline or centerline that you used and move it to your liking. If you selected an endpoint vertex, you can pivot that vertex around 360 degrees and the profiles will update in real time. This is helpful when checking for spikes. If you select the middle vertex then you can shift the entire centerline around.

If you created a profile alignment by picking points and you want to save that polyline you created then toggle on Draw Plan View Polyline. If you do not choose Draw Plan View Polyline than the polyline will be lost when you exit out of the Quick Profile command. Grid Ticks Only marks elevations and distances but does not draw them into grids.

The Save icon allows you to save the profile as a (.pro) file by whatever name you give it. The Draw icon allows you to draw the profile right on your drawing. Set the layer name, vertical and horizontal scale as desired, pick a starting point to draw, and the profile is created. Note: the below example has a vertical scale of 5 feet per grid and a horizontal scale of 50 feet per grid.
Prompts

Pick starting point (CL-Centerline,P-Polyline): p
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: 
Loading edges...
Loaded 5057 points and 14923 edges
Created 9866 triangles

Prerequisite: a surface
Keyboard Command: TK.QUICKPRO, QUICKPRO

Cut/Fill Centroids
This command calculates all the areas of cut and fill between two triangulation surfaces. The center of mass or centroid for each area is calculated. The Minimum Region Volume is an optional filter that will skip reporting areas with volumes less than the specified amount. The Generate Labels option draws a symbol at the centroid and text for the region name and volume. The Generate Boundaries option draws closed polylines for the perimeters for each area. The Hatch Regions option is used to visually shows cut/fill areas in your drawing. Separate hatch patterns can be used for cut and fill areas.

The Use Inclusion/Exclusion Areas option will make the program prompt for polyline perimeters for the inclusion and exclusion areas on the site. For example, use an inclusion perimeter to calculate within an area of interest. When this option is off, the program uses the full extent of the surfaces.

A report is generated with the volumes and centroids for all the cut and fill areas. When the Report Optimized Earth Movement option is active, the report includes a list of the earthwork movements between cut and fill areas that minimizes the overall earthwork movement (volume * distance) where the distance is distance between the centroids.
Cut & Fill Centroid Report

Original Ground: G:\osem4\src2\work\demol-ex.flt
Design Surface: G:\osem4\src2\work\demol-fn.flt

<table>
<thead>
<tr>
<th>Region</th>
<th>Volume(C.Y.)</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>3822.9</td>
<td>2190032.48</td>
<td>6135170.29</td>
</tr>
<tr>
<td>2</td>
<td>3053.7</td>
<td>2190117.40</td>
<td>6134982.40</td>
</tr>
<tr>
<td>3</td>
<td>1.8</td>
<td>2190334.67</td>
<td>6135199.41</td>
</tr>
</tbody>
</table>

Earth Movement Report:

<table>
<thead>
<tr>
<th>From Region</th>
<th>To Region</th>
<th>Volume(C.Y.)</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3053.7</td>
<td>206.12</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>1.8</td>
<td>303.59</td>
</tr>
<tr>
<td>1</td>
<td>External</td>
<td>767.4</td>
<td></td>
</tr>
</tbody>
</table>

Total Internal Volume = Distance: 629972.20
Total External Volume: 767.44

Here is the Cut and Fill Centroid Report for the above example. It shows the volumes, the coordinates of the centroids, and the Earth Movement Report. The Earth Movement Report shows the minimal distances for moving Cut to Fill areas.

Prerequisite: Existing and Design surfaces
Keyboard Command: tk_cutfillc

Cut/Fill Map Legend

This command will draw a Cut/Fill Map Legend on your drawing. It will display the cut/fill amount, color, and range, as seen below.

Prerequisite: Cut/Fill amounts
Keyboard Command: CF_MAP_LEGEND

Draw Surface As Grid

This command writes a grid file (.grd) from an existing triangulation file (.flt or .tin) in the current drawing.
After selecting the triangulation file to convert, you are prompted for the X, Y grid interval and the Layer name.

**Prerequisite:** a existing or design surface  
**Keyboard Command:** draw_surface_grd

**Perimeter Polylines Properties**
This command allows you to control the properties of any perimeter polyline (Note: Perimeter polylines also have to be closed polylines). Select a polyline and the following dialog appears. Here you can define the functionality of the polyline in regards to, the Site Boundary, Areas of Interest, and Topsoil Removal/Replacement. These properties can also be set separately using the Boundary Polyline, Areas of Interest, and Topsoil Removal/Replacement commands found under the Tools menu of Carlson Takeoff.
Update Colors For Set Elevations

This command refreshes the color of entities depending on their elevation and layer target. For entities assigned to the Existing or Design layer targets, if the entities are at zero elevation then their color is set to grey. Otherwise the entities have their true, original color. If the Automatic Update Colors command under Settings->Configure->Takeoff Module is toggled off, then this command is the way to update the entity colors after editing elevations.

Prerequisites: none  
Keyboard Command: update_tk_colors

Convert LDD-AEC Contours

This command allows you to convert LandDesktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the object enabler installed, download the latest version from www.autodesk.com.

You can use the List command to determine if contours are polylines or AECC_Contour objects. Here is an example listing:

AECC_CONTOUR Layer: "CONT-MJR"
Space: Model space
Handle = 429
Major Contour Interval
Elevation: 1005.00
Smoothing: None
Number of Vertices: 48
Open
Length: 560.25
Constant width: 0.00
Style Name: Standard

Export Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. This polyline file is a text file that has three formats. The Carlson format (.PLN) is used by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number". Then the points for the polyline are listed on separate lines in X,Y,Z format. Here is a list of the available color numbers:

0 = Black 8 = Dark Gray
1 = Blue 9 = Light Blue
2 = Green 10 = Light Green
3 = Cyan 11 = Light Cyan
4 = Red 12 = Light Red
5 = Magenta 13 = Light Magenta
The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline. The DTM and Idan formats create linework files for the DTM and Idan programs.

**Prompts**

Polyline file format [<Carlson>/DTM/Idan/MicroStation]? press Enter for Carlson format
Specify File to Write dialog create a new file or append to existing
Polyline file for Grid File Utilities macro [Yes/<No>]? press Enter The option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.
Include Z coordinate in polyline file [Yes/<No>]? press Enter This option controls whether the polyline vertices are written in 2D or 3D.
Specify Exclusion/Warning Polylines [Yes/<No>]? press Enter This option applies to machine control for warning areas.
Specify WorkZone Polylines [Yes/<No>]? press Enter This option applies to machine control for working areas.
Reduce Polyline Vertices [Yes/<No>]? press Enter This option applies Reduce Polyline to the polyline vertices before writing the file.
Enter reduce offset cutoff <0.1>: press Enter
Decimal places for coordinates <2>: press Enter
Select polylines, lines and arcs to write.
Select objects: pick the entities to process
Done.

Sample Polyline File:

POLYLINE,15
47639.82,74540.11,0.00
47670.49,74565.79,0.00
47701.08,74591.49,0.00
49375.61,76358.47,0.00
50066.86,76846.75,0.00
POLYLINE,15
47633.24,74547.97,0.00
47663.90,74573.65,0.00
etc...

Keyboard Command: polywrite
Prerequisite: Polylines in the drawing

**Import MicroStation DGN**

This command takes a MicroStation DGN file and imports the MircoStation elements into your current DWG drawing. After selecting the DGN file you want to import, you will receive a conversion report like the one below:

Element
Type Name Encountered Converted
3 Line3d 273 273
4 LineString3d 48 48
6 Shape3d 1 1
After the command has imported the DGN file, run View > Zoom > Extents to see the converted entities.

**Pulldown Menu Location:** Tools > Import/Export  
**Prerequisite:** a MicroStation DGN file  
**Keyboard Command:** dgn_in

**Import PDF File**

This command allows you to bring in a Adobe .PDF file and covert it into polylines or a .bmp image. In order for this command to work you need to download and install Ghostscript from the website http://sourceforge.net/projects/ghostscript/. For 32-bit computers you'll want to download gs(xxx)w32.exe by clicking on the "Download Now!" button located on the main page.

If gs(xxx)w32.exe is not listed under "Download Now!" or you are running a 64-bit computer, click on the "View all files" button to the right of the "Download Now!" button. A list of Ghostscript versions will appear below (i.e., 8.71, 8.70). After downloading the .exe to your computer double click on it to install.
Ghostscript is a free software and should only take a few minutes to install. Once it is installed, Carlson Takeoff will automatically utilize this software when you run Import PDF file. After selecting the file you want to insert, the below window will open.

Wait for the window to close on its own (closing this window on your own will exit the command).

Next you will be prompted for Insert as Image, Insert Linework, Save to Image File. Insert as Image will convert the PDF into a .bmp image that is inserted into the drawing. When inserted, a .bmp image is visible on the screen, but unusable as CAD linework. Save to Image File simply saves the .bmp file without inserting it into the drawing. Insert Linework will convert the PDF file into usable CAD polylines and Use Colors for Layers will parcel out the polylines onto layers based on the colors or gray scale of the PDF.
If the PDF you are converting is a raster image, an not a vector PDF, then you will receive this additional dialog:

In this dialog, you can specify the Layer, Color, Scale, and whether to draw the entities on the screen or write a .dxf file. Minimum Polyline Length will reduce the amount of line segments created from the conversion.

When you are inserting the converted PDF into the drawing, will you receive the following prompts:

Pick point to insert PDF: Specify the insertion point for the PDF converted linework by either picking on the screen or typing in a coordinate (Example: 1000,1000).

Specify rotation angle: To accept the default value displayed, press Enter, or enter the rotation angle (Example: 90).

Specify scale <1.0>: To accept the default value displayed, press Enter, or enter a scale factor. If the scale factor is not known, which is typical, accept the defaults to this prompt. The proper scale factor can be determined by running Inquiry>Standard Distance on a known distance on the site (ie, the side of a building or the distance across the road). If the side of a building is labeled as 60' and Standard Distance reports it is at 120', then the Scale factor is 0.5 (60/120). Run Edit>2D Scale, select the imported objects, specify a base point of 0,0 and use the Scale Factor you determined with Standard Distance to scale the entities correctly.

After the command has imported the PDF file, run View > Zoom > Extents to see the converted entities.

**Pulldown Menu Location:** Tools > Import/Export  
**Prerequisite:** a PDF file, Ghostscript installed  
**Keyboard Command:** loadpdf

**Import Raster To Vector**

This command allows you to bring in a monochrome .bmp image and covert it into polylines. To process other file types, such as .tif or .jpeg, open the image up in Microsoft Paint and Save As the file as a monochrome .bmp. In the dialog below, you can specify the Layer, Color, Scale, and whether to draw the entities on the screen or write a .dxf file. Minimum Polyline Length will reduce the amount of line segments created from the conversion.
Keyboard Command: ras2vec
Prerequisite: a monochrome .bmp file

Import/Export Carlson Triangulation Files
Import Carlson Triangulation Files allows you to import an external surface file into TakeOff to use as a named surface. Export Carlson Triangulation Files allows you to take a Surface Triangulation file and save it independent of the drawing.

Prerequisite: .TIN or .FLT files
Keyboard Command: import_tin, export_tin

Convert Polylines To Text
This command will create text from polylines generated by a PDF or raster import. When you run the command you will be prompted to load or create a Character file (.ocr). This file acts as a library that associates polylines in your drawing with a particular character (A, B, C, 1, 2, 3, etc.) to convert into text. From the Polylines To Text dialog, you have the ability to modify the Character library and to Convert selected linework in the drawing.
To build the Character library, pick on the Add button. Here you type in the character you’d like to add, choose the font style the text will appear on, and then select the polyline(s) that comprise the character.

After the desired library has been compiled, Convert will prompt you to select the linework you wish to process from the library into text. Below is an example of PDF linework convert from polylines into text.

Run Save or Save As to use the Character file (.ocr) on future projects.
Convert Dashes To Polylines

This command connects sequential dashes into polylines. The program will prompt you to select a sample and adjacent dash line. This identifies the layer and approximate gap between dash lines. It is helpful to isolate this layer before running the command. Next, select the dash lines to process and press enter. Below are typical results of the conversion.

Before Conversion
After Conversion

Pulldown Menu Location(s): Tools > Import/Export
Keyboard Command: dash2pl
Prerequisite: Dashed linework to convert into continuous polylines.

Elevate Menu

Change Elevations
This command will change the elevation of selected Entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson TakeOff points are selected, their attribute text and z axis coordinate are changed.

Prompts

Ignore zero elevations (<Yes>/No)? Press Enter. If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Select/<Enter Elevation <0.0000>:125
Change Layer for changed entities [Yes/<No>]: No
Elevation to change to:
By using the Absolute option all entities selected are changed to the elevation 125.

Select Entities for elevation change.
Select objects: C
First corner: (pick point)
Other corner: (pick point)
Select objects: [Enter]

Keyboard Command: chgelev
Prerequisite: Something to change
Set Polyline to Elevation

This command allows you to assign elevations to one or more polylines. The elevation can be assigned by entering in the value or by picking a text entity that has the elevation.

Prompts

Select/<Enter Elevation <0.0000>>: Select a text entity or type in an elevation. Press enter for the default elevation in brackets.

Select Polyline for elevation change. Pick on the screen a polyline you wish to change such as:
LW POLYLINE
Done.
Set another polyline [<Yes>/No]? Press Y to pick another polyline to assign an elevation to. Type in N to finish the command.

Keyboard Command: set_pline_z
Prerequisite: A polyline and an elevation to assign it.

Edit-Absign Polyline Elevations

This command allows very precise control of 3D polylines, specifically in the ability to edit vertex elevations, as well as add, delete, or move vertices. You can also control the location of polyline vertices as defined by the station and offset of the vertices relative to a Centerline.

Polyline vertices are designated as either Control or Free vertices. The elevation of Control vertices are set and held, the elevations of Free vertices are interpolated. In the drawing, control vertices are shown with red boxes, along with their vertex number and elevation. Free vertices are displayed with blue boxes and are not annotated.

When you run the command, you are first prompted to select a polyline to edit. When you pick a polyline to work with, the following control panel appears on the left side of your screen.
The top row of buttons across the top of the control panel are used to manipulate the view in the drawing with various Zooming and Panning options. The second and third row of buttons will change as you select different tabs, but are essentially used to add vertices, delete vertices, or pick elevations or locations for vertices. The Add vertex at crossing icon will pick up the elevation of any selected crossing linework and add an elevated vertex at the intersection.

The four tabs in the panel provide access to control of polyline vertex Elevation, Position, Offset and Settings.

**Elevation:** This tab displays the vertices of the polyline, each with a check box to set whether it is a control vertex or free, its assigned number, its elevation, and the slope from the previous vertex to that vertex. Selecting a vertex highlights its grip in the drawing. Once selected, you can enter an elevation or slope for that vertex in the spaces below the list, thereby automatically setting the vertex to a control vertex. The Base Elevation is used to adjust the elevations of all the vertices simultaneously.

**Position:** The Position tab displays the coordinates of each vertex. To move a vertex, you can type in new coordinates, use the Pick Position icon to specify a new location for the vertex on the screen, or you can grip the vertex and drag it to a new location.

**Offset:** The Offset tab requires the selection of a Centerline to reference. Once a Centerline is designated, the Station, Slope, and Offset of each vertex relative to the Centerline is displayed and can be edited.

**Settings:** The Settings tab provides control over various overall options pertaining to the use of the command. For example, hiding free vertices and setting how to report your slopes between vertices. "Allow X-Y Dragging" lets you control whether a polyline can move horizontally when you add new vertices to it. Options are Always, Never, or to be Prompted each time when adding a vertex.

**Right-click menu:** There is a right-click menu available at all times which also gives access to a variety of functions and settings.
2D to 3D By Surface Model

This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with surface entities (contour polylines, triangulation lines) and by interpolating elevations from these intersections at the original vertices locations. An application for this command is to create breaklines. For example, a ridge breakline could be generated from contour lines by drawing a 2D polyline along the ridge and across the contours. Then this command could grab the contour line elevations along the polyline to make a ridge breakline.

In addition to using entities in the drawing, the 2D polyline can be converted to 3D using a surface model stored in triangulation (.flt or .tin) file. If you use a file, then you can also use the polyline's current elevation as a vertical offset from surface.

Prompts

*By Screen Entities:*
Source of surface model [File/<Screen>]? Type S for Screen
Select polylines to convert.
Select objects: select the polyline(s) to convert
Select surface 3DFaces, lines and polylines.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)

Reading points ... 692

Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.

Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.

Converting polylines ...
Converted 1 polylines.

*By a .flt or .tin File:*
Source of surface model [<File>/Screen]? Type F for File
Select polylines to convert.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)

Use current polyline elevations as vertical offset from surface [Yes/<No>]? Press Enter
This will offset the new polyline by its current elevation. That is, if a polyline has an elevation of -4 and the surface you are converting it to has an elevation of 800, then saying Yes will drape the polyline at an elevation of 796.

Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.

Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.

*Keyboard Command: 2dto3dp*
*Prerequisite: A polyline and surface lines or grid file or triangulation file.*
2D to 3D Polyline by Points

This command adds 3D data to polylines by using the elevations of points. At each vertex of the polylines, the program looks for a point with elevation at the same x,y location. The points can be Carlson point blocks or AutoCAD POINT entities. This routine can be useful if the linework is created in 2D at zero elevation, and points with elevation are located along the linework. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more than one method. The linework can be converted into 3D polylines with this command. For example, a centerline polyline with arcs may need to be created in 2D for stationing because AutoCAD does not allow arcs on 3D polylines. To use this polyline as a breakline in surface modeling, this command can convert the polyline into a 3D polyline.

**Prompts**

Select points and polylines.

Select objects: select polylines to convert and the points with elevation

![Diagram of elevation points]

**Keyboard Command:** 2dto3dpt

**Prerequisite:** A polyline and points

2D to 3D Polyline-By Text

This command adds 3D data to polylines by elevation labels. This command will prompt you for samples of the elevation labels and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the polylines with their labels you want to convert.

You will then be prompted to enter in an elevation to add to label values. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 539.97, 540.02, 540.11 sometimes, like in the example on the side, they are listed as 39.97, 40.02, 40.11. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing. This command will assign elevations from the labels to nearby vertices. If vertices do not have a close elevation label than they will be interpolated from vertices that are nearby elevation labels. The vertices elevated in this command will appear as control vertices in the command Edit-Assign Polyline Elevations. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more than one method.
Prompts

Select sample of elevation text: Pick a text label
Select sample of a polyline to convert: Pick a polyline
Select polylines to convert and elevation labels.

Select objects: Select all the entities to process
19 found, 19 total

Enter elevation to add to label values <0.00>: 500
Pre-processing entity #19 of 19
Filtering text entities
Processing elevation text #18
Remaking polyline #1

Keyboard Command: elevfb
Prerequisite: 2D polyline and elevation labels

2D to 3D By Text With Leader

This command will assign elevations from the labels to the polylines by following the label leaders to their corresponding vertices on the polyline.
This command will prompt you for samples of the elevation labels, the leaders, and the polylines to convert. The program uses these samples to know the layer names for the labels and linework to process. Then select all the labels and leaders for the polylines you want to convert. You will then be prompted to enter in an elevation to add to label values. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 800s instead of labeling every elevation 817.85, 817.40, 817.30 sometimes, like in the above example, they are listed 17.85, 17.40, 17.30. This command allows you to add a given amount, such as 800, to every label elevation to produce the correct elevation in the drawing.

Carlson TakeOff searches for all leaders and gathers their associated text. If the program finds different labels in the elevation text, then this dialog box allows you to select the text you want to create 3D polylines. In this example you might want to use elevations followed by TC. This dialog box allows you to select that text and exclude the other text which is not to be used in the elevations of the polyline, such as FS.
If you are creating 3D polylines from multiple elevation labels than this dialog box will allow to offset certain labels by a given amount. In the above example you can offset an elevation labeled FS by .50 so that it matches vertices set by TC labeled elevations. The vertices elevated in this command will appear as control vertices in the command Edit-Assign Polyline Elevations. It can also be used in conjunction with other 2D to 3D commands to elevate polylines by more then one method.

**Prompts**

Select sample of elevation text: Pick a text label
Select sample of an annotation leader: Pick an annotation leader
Select sample of a polyline to convert: Pick a polyline
Select polylines to convert, leaders and elevation labels to process.
Select objects: Select the desired entities
22 found
3 were filtered out.

Select objects:

Enter elevation to add to label values \(<0.00\): 800
Pre-processing entity #19 of 19
Filtering text entities
Processing leader #6
Remaking polyline #1
**Keyboard Command:** elevfl  
**Prerequisite:** 2D polyline, elevation labels, and leaders

### 2D to 3D Polyline by Start-End Elevations

This command allows you to convert a 2D polyline to a 3D polyline by specifying the starting and ending elevations of the polyline. All intermediate polyline vertex elevations are linearly interpolated from these end point elevations.

**Prompts**

Select polyline to assign elevations:  
Enter starting elevation: 109.85  
Percent/Ratio/<Enter ending elevation>: 112.16  
Select polyline to assign elevations (Enter to End): press enter to end

**Keyboard Command:** 2dto3dpl  
**Prerequisite:** A polyline

### Draw Building Envelope Polyline

This command creates a rectangular polyline around selected linework. This can be used to give a building all one elevation.

![Draw Building Envelope Polyline](image)

Select the entities that make up the building. Next you will be prompted to name the layer and In the dialog, you can set the layer name for the new linework, set one offset distance, or select to be prompted for each side to offset. Also, you can set the elevation of the envelope and trim crossing linework to ensure you have a flat pad.

**Chapter 9. Takeoff Module**
Length Snap Resolution: Will round the dimensions of the created Building Envelope by a certain tolerance. For example, if you select None you may get a Building Envelope of 37.4 x 25.2. However, if you set the Length Snap Resolution to 0.5, you will get a Building Envelope of 37.5 x 25.0.

**Prompts**

Select building lines.  
Select objects: *pick the linework that makes up the perimeter of the building*  
Enter the segment horizontal offset <0.000>: 10  
Enter the segment horizontal offset <10.000>: Enter  
Enter the segment horizontal offset <10.000>: 5  
Enter the segment horizontal offset <5.000>: Enter  
Select/<Enter Elevation <0.0000>: 400  
Draw another building envelope [<Yes>/No]? No

**Keyboard Command:** bldg.perim  
**Prerequisite:** a pad

**Pad Polyline By Interior Text**

This command allows you to set one or more pad elevations using interior text labels.

After running the command you will be prompted to select the layers you want to use for the pad elevation and for the boundary of the pad. Sometimes pads are drawn with linework from two different layers and Carlson TakeOff allows you to pick all the correct linework.

![Pad Polyline Options](image)

This dialog box allows you to create a new layer with the correct x,y coordinates and elevations. If the pad shares the same coordinates with other linework with different elevations than this dialog box allows you to offset the new polyline to avoid the problem of shared occupied points with different elevations. You can choose to have an interior offset or an exterior offset and also decide how much to offset the new polyline. Selecting Both will give both the interior pad elevation and the exterior contour elevations. This helps the transition from you pad elevation to the design contouring. The Snap Tolerance field joins linework which falls within the range you set to create a pad. Trim Outside Elevated Polylines will trim out contour elevations that go through your pad that you are not using elevations from within the pad.

Elevation to add to text values adds to the values from the elevation labels. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing.
After running the command you will be prompted to select the layers you want to use for the pad elevation and for the boundary of the pad. Sometimes pads are drawn with linework from two different layers and Carlson TakeOff allows you to pick all the correct linework. In addition, if your text has multiple Prefixes and Suffixes you will be prompted to select the ones you want to use the elevation from.

After clicking <OK> select all the pads and their elevation labels that you wish to change, press <Enter>, and the new layer with elevations will be created and placed in the Design target.

Prompts
Select layer sample of elevation text: Pick a label text
Selected text layer —-TX07
Select layer sample of boundary linework:
Selected linework layer PAD
Select another layer sample of boundary linework (Enter to continue):
Select text and linework to process.
Select objects: 1 found
Select objects: 1 found, 2 total
Select objects:
Analyzing entire selection...
Set elevation for 1 polylines.

Keyboard Command: pad_by_text
Prerequisite: Pad polylines and elevations

Convert Spot Elev To Points
This command takes spot elevation entities with zero elevations and assigns them elevations according to corresponding elevation labels. This dialog box allows you to choose the format of the spot elevations entities that you want to convert.

Output:
Carlson points: creates Carlson points at elevation of spot and stores them in coordinate file
AutoCAD points: creates AutoCAD point objects at elevation of spot

Is spot indicator a part of the elevation label?
If set to "Yes", four choices for Spot indicator are available to select from:
Text insertion point: uses the insertion point of the text for the location of the new point
Text decimal point: uses the decimal point in the text for the location of the new point
Text plus sign: uses the plus sign in the text for the location of the new point
Text letter x: uses the letter x in the text for the location of the new point

If set to "No", five choices for Spot indicator are available to select from:

Linework leader: creates a data point at the end of a leader

Linework cross: creates a data point at the intersection of a linework cross
Text plus sign: creates a data point at the insertion point of a text plus sign
Text letter x: creates a data point at the middle of a text letter x
AutoCAD point: creates a data point at the node of an AutoCAD point

Block References:
Process Block References: If check box is cleared, Carlson Civil searches only text entities for elevations, but if checked, Carlson Civil will search block references for elevations that are stored as attributes of a block. Use this option if the elevation is an attribute and the symbol designating the location of the spot elevation are both part of the block definition.
Expand Block References: Use this option to search block references when the elevation is stored as an attribute of a block, but the symbol designating the location of the spot elevation is a different block or even other geometry that is not defined within a block.

Base elevation: The value entered here is added to the existing spot elevations for all newly created points. Often times elevations are abbreviated to save time and space. If every elevation in a drawing is in the 500s instead of labeling every elevation 523.5, 543.3, 537.2 sometimes they are listed as simply 23.5, 43.3, 37.2. This command allows you to add a given amount, such as 500, to every label elevation to produce the correct elevation in the drawing. Note: The base elevation will not be added to any elevations that are closer to the base elevation value.
than they are to 0; e.g. if a base elevation of 500 is specified, 500 will be added to elevations like 23.4, 45.5, etc, but will not be added to elevations like 456.4 or 468.9.

**Prefix Filter:** Carlson Civil examines all selected spot elevations for prefixes or suffixes. If they are all the same, the command proceeds, but if there are different prefixes and/or suffixes found, the Prefix Filter dialog box is invoked. This dialog box allows you to select which prefixes and/or suffixes to use to create spot elevations, and also allows you to use different offset values for each.

![Prefix Filter dialog box](image)

**Prompts**

**Starting point number <1>:** press Enter

Select TEXT, MTEXT spot elevations to process and any associated leader lines:

Select objects: pick entities to process

Pre-processing entity #40 of 40...

Filtering text entities

Processing elevation #40...

Converted 40 spot elevations.

**Keyboard Command:** spotelv2

**Prerequisite:** Spot elevations

**Assign Contour Elevation - Multiple in Series**

This command can be used to quickly and accurately assign the elevation of series of AutoCAD polylines that have been converted from raster or digitized without correct elevations. The routine will automatically assign elevations to the polylines crossing the fence line selected by two points. At the same time the elevations are changed, the program can assign it a new layer, color, linetype, and polyline width. This process usually works best if contours
are in a temporary (white) layer to start. When they are processed, they will take on the color of the new layers making it easy to distinguish which polylines have been processed.

Prompts

Settings/First Point: *(Press S to change settings or pick first point.)*
Second Point: *(Pick second point)*
Beginning Elevation <0.00>: 1020
Increment Direction U/D <U>: *(enter)*

Keyboard Command: grpcelev
Prerequisite: digitized polylines

Assign Contour Elevation - From Contour Labels

This command allows you to set elevations to contours from elevation labels.
Select a sample of the elevation text to be used on the contouring. Next, select a sample of the contouring that you want to add the elevations to. Now select all the contours and their corresponding elevation labels and press <Enter>. Carlson TakeOff will then add elevations to all the contours. You may be prompted to distinguish what contour goes with what elevation label. You can either press <Enter> to accept the contour that Carlson TakeOff has selected or you can Press <N> to choose another contour.

Prompts

Select sample of elevation text:
Select sample of a contour line:
Select contour lines and elevation text to process.
Select objects: all
5049 found
4041 were filtered out.

Select objects:

Joining adjacent polylines...
Reading the selection set ...
Joining ...
Pre-processing entity #1008 of 1008
Filtering text entities
Processing elevation text #518

Conflict detected: pick contour corresponding to current elevation text
Press N for next selection or Enter to accept current:
Remaking polyline #311

Keyboard Command:  TXTCELEV
Prerequisite: contours and contours labels

Assign Contour Elevation - Single Elevation Group

This command changes the elevations of polylines and can be used to set the elevations of contour polylines. The routine begins at a specified elevation and prompts for a selection set of polylines to set to the elevation. Then the routine repeats using the last elevation plus the elevation increment. Enter an empty selection set to exit the routine.

Prompts

Starting elevation <0.0>: 500.0
Contour interval (negative for down) <1.0>: 5.0
Select polylines to set to elevation 500.0.
Select objects: pick the polylines
Select polylines to set to elevation 505.0.
Select objects: pick the polylines
Select polylines to set to elevation 510.0.
Select objects: Press Enter
Keyboard Command: setcelev
Prerequisite: polylines
Drape 3D Polyline On Surface

This command converts a 2D polyline into a 3D polyline by calculating 3D polyline vertices at all the intersects of the 2D polyline with surface entities (contour polylines, triangulation lines) and by interpolating elevations from these intersections at the original vertices locations. An application for this command is to create breaklines. For example, a ridge breakline could be generated from contour lines by drawing a 2D polyline along the ridge and across the contours. Then this command could grab the contour line elevations along the polyline to make a ridge breakline.

In addition to using entities in the drawing, the 2D polyline can be converted to 3D using a surface model stored in triangulation (.flt or .tin) file. If you use a file, then you can also use the polyline's current elevation as a vertical offset from surface.

Prompts

By Screen Entities:
Source of surface model [File/<Screen>]? Type S for Screen
Select polylines to convert.
Select objects: select the polyline(s) to convert
Select surface 3DFaces, lines and polylines.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)

Reading points ... 692

Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.
Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.
Converting polylines ...
Converted 1 polylines.

By a .flt or .tin File:
Source of surface model [<File>/Screen]? Type F for File
Select polylines to convert.
Select objects: select the surface entities (contour polylines, breaklines, triangulation lines, etc)

Use current polyline elevations as vertical offset from surface [Yes/<No>]? Press Enter
This will offset the new polyline by its current elevation. That is, if a polyline has an elevation of -4 and the surface you are converting it to has an elevation of 800, then saying Yes will drape the polyline at an elevation of 796.
Keep existing polylines [Yes/<No>]? Press Enter
This command creates a new 3D polyline, and this prompt allows you to keep the old polyline.
Set layer name for converted polylines [Yes/<No>]? Press Enter
This allows you to assign the new polyline to a layer.

Keyboard Command: 2dto3dp
Prerequisite: A polyline and surface lines or grid file or triangulation file.

Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution you will be asked to select a polyline to edit. Upon selection a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. Then pick near the vertex you wish to edit, and the following dialog appears.

At the top of the dialog it identifies the type of polyline, being 2D or 3D. In the case of 2D polylines it allows
you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also
determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values
in the dialog, new values for derivatives are being calculated. For example if you change the horizontal distances,
the coordinates will change.

![Edit Polyl ine Vertex dialog](image)

**Prompts**

- **Select polyline vertex to edit:** *pick a polyline at the point to be modified*
- **Pick or enter position** `<5264.23,5048.21>`: *pick a point*
- **Enter elevation** `<0.00>`: *Press Enter*
- **Select polyline vertex to edit:** *Press Enter to end*

**Keyboard Command:** editpl

**Prerequisite:** A polyline.

---

**Edit Contours**

This command revises a segment of a contour polyline. Begin by picking a point on the contour where you want to
start editing. Then pick new points for the polyline. When finished picking new points, press Enter and then pick a
point on the contour to connect with the new points. The polyline segment between the start and end points is then
replaced with the new points.

**Prompts**

- **Select contour to edit:** *pick the contour polyline at the place to start editing*
- **Pick intermediate point (Enter to End):** *pick a point*
- **Pick intermediate point ('U' to Undo, Enter to End):** *pick a point*
- **Pick intermediate point ('U' to Undo, Enter to End):** *Press Enter*
- **Pick reconnection point on contour:** *pick the contour polyline at the place to join*
Edit this contour by picking new points
Contour with segment replaced with new points

**Keyboard Command:** editctr
**Prerequisite:** polylines with elevation (contour polylines)

**Snap Contours to 3D Polylines**
Snap Contours to 3D Polylines can be used to align contour polylines to match elevation with intersecting of a 3D polylines. Doing so will fix spikes in a surface model. The program will ask for the Contours to be adjusted. Pick will allow you to grab the contours from the plain view. Select allows you to identify the layer(s) from a list. The layers under Contour Layers will be adjusted to match the Reference Layers at the point of intersection. A Reference layer can de identified by Pick or Select as well.
The Maximum Snap Distance is the furthest distance along the Reference line the Contour polyline will move in order to match elevations. Z Tolerance sets the minimum elevation difference between the Reference line and the Contour polyline for the program to process. Anything less than this number will not be modified. Transition Distance is the length over which the positioning change will be applied to the Contour polylines.
After selecting OK, you will be prompted for the entities to process. Pick or Window Select the linework you want to process. You can also type in "all" to select everything. Here is a standard report that is displayed on the command line:

Entities in set: 282
Select entities:
Contour polylines: 125 Processed, 12 Adjusted

Pulldown Menu Location: Elevate (in Takeoff), 3D Data (in Civil)
Prerequisite: 3D linework
Keyboard Command: snap_cntrs

Digitize Menu

Tablet On
Executes AutoCad's TABLET command to set the tablet on. Refer to the AutoCad Reference manual for further information.

Note: Function key [F4] can toggle on/off tablet.

Keyboard Command: tablet
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

Tablet Off
Executes AutoCad's TABLET command to set the tablet on. Refer to the AutoCad Reference manual for further information.

Note: Function key [F4] can toggle on/off tablet.

Keyboard Command: tablet
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

Tablet Calibrate
You can calibrate the tablet/digitizer in one of two ways: Known Reference Points or Drawing Scale with New Reference Points. Reference points are the foundations of whatever data you digitize into the computer. Takeoff bases everything from drawing location to drawing scale on the reference points you digitize.

Drawing Scale with New Reference Points method is very convenient when you don't know the precise coordinates of the entities on your drawing. As long as you can obtain the drawing scale from your plan, this method can establish a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). Takeoff would computer the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display on the Tablet Calibration Dialog next time when you calibrate the tablet, so you can digitize back to the previous coordinates using Known Reference Points method if you are working on the same drawing, though you might have moved or rotated your drawing on the digitize board..

If you know the precise coordinates of two points, you can select Known Reference Points method, which
establishes a coordinate system that is exactly match the coordinates in the field or on your drawing. Furthermore, Takeoff saves the coordinates of the two reference points from previous calibration and displays them on the Tablet Calibration Dialog next time when you calibrate the tablet. If you want to continue to work on the same drawing, you can use the Know Reference Points method with the saved coordinates to digitize back to your previous coordinates although you might have moved or rotated your drawing on the digitizer board.

For accurate takeoff calculations, choose two points that can be easily found in the field and are farther apart rather than closer together.

Prompts

Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.
Pick first reference point: pick a point on the drawing
Pick second reference point: pick another point on the drawing
**Keyboard Command:** digsetup  
**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up.

---

**Digitizer Setup**

Digitizing is the act of inputting data into the computer by tracing the data from a plan sheet. You need to have a digitizer board, puck, Carlson Takeoff, your computer and your plan to do digitizing. Wintab is a digitizer driver that lets you to use the digitizer cursor as both a digitizer cursor and a mouse. You need to install Wintab when you install Carlson Takeoff. Wintab can be downloaded from GTCO web site: http://www.gtcocalcomp.com/supportgtcosoftware.htm. Select the driver version that suits the type of your digitizer board well.

After you installed Wintab driver on your computer, you set up you digitizer to the correct point mode. In Windows 2000/XP, go to **Start->Settings->Control Panel->TabletWorks**, highlight the **16-Btn Cursor**, and select **Mouse** as the **Pointing Mode**, which lets the digitizer cursor moves relatively to the screen coordinates. This step is indicated in the following **TabletWorks Control Panel** dialog.

![TabletWorks Control Panel](image)

The next is to set up the pointing device in Carlson Takeoff. Open up Takeoff and go to pull-down **Settings->Preferences**, click tab **System**, select **Wintab Compatible Digitizer** as **Current Pointing Device**, and set the **Accept input from** to **Digitize and mouse**. Please refer to the following **Options** dialog.
Now, you are ready to use your digitizer. On the bottom of the screen, there is a tray icon TABLET on the right side of MODEL. You can use accelerator key F4 to toggle on/off the tablet.

### Save Tablet Calibration
This command saves current tablet calibration to a file. You are prompted to enter a file name.

**Keyboard Command:** tablet1  
**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

### Load Tablet Calibration
This command restores the tablet calibration parameters from a file and load it into the current drawing. You are prompted to specify a file name.

**Keyboard Command:** tablet2  
**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. The calibration file should be associated to the current drawing, and the current drawing shouldn't have been moved on the digitizer board since last calibration.

### Digitizer Settings
This command allows you to select the puck layout and set Auto On/Off features.
Auto Tablet On For Digitize Commands means after you select a digitize command your puck will automatically be put in Digitize Mode. If this is toggle off, then you will need to turn Tablet on separately from running a digitize command.

Auto Tablet Off After Digitize Commands means you will return to Mouse Mode after running a digitize command. Read below for more on Mouse and Digitize Mode.

Puck Layout

The 16-button puck can be used as either a mouse or a digitizer. It's very important to understand how the 16 buttons are mapped in both modes.

Mouse Mode

When the tablet is off, the puck is in Mouse Mode. The top-left button is the left mouse click, and the top-right button is the right mouse click. The labels on the other buttons do not mean anything. All buttons are mapped as same as the buttons of the default pointing device in AutoCad. Please refer to AutoCad Reference manual for further information.

Digitize Mode

When tablet has been calibrated and is on, the puck is in digitize mode. It is mapped as a small keyboard, which enables you to enter numerous values such as elevation, thickness and offset etc., and also provide you some functionality to digitize various entities. Currently there are two puck layouts in Takeoff, shown in the figure below. After you install Carlson Takeoff and finish setting up the digitizer, you go to the pull-down menu Digitize->Puck Layout to select a 16-button puck layout. A button mapping would be created and Takeoff would recognize the buttons as represented.
Layout 1 is Carlson Puck Layout, which is the most common layout used in Carlson Takeoff. Layout 2 is for users who don't have a Carlson Puck. If your puck is different than these two layouts, please contact Technical Support for help setting the mapping for your 16 button puck.

**Prompts**

**Digitizer Settings Dialog**
Specify the Digitizer Puck Layout to layout 1 or 2

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed.
**Keyboard Command:** dig_config

**Digitize Existing**
This sets the layer target to existing. Set this prior to running any digitizing command and anything you digitize will be assigned for your existing surface. Checkout the Define Layer Target/Material/Subgrade command under Tools for more on targets.

**Keyboard Command:** set_digitexist
**Prerequisite:** none

**Digitize Design**
This sets the layer target to design. Set this prior to running any digitizing command and anything you digitize will be assigned for your design surface. Checkout the Define Layer Target/Material/Subgrade command under Tools for more on targets.

**Prerequisite:** none
**Keyboard Command:** set_digit_final

**Digitize Other**
This sets the layer target to other. Set this prior to running any digitizing command and anything you digitize will be assigned to the Other target. Checkout the Define Layer Target/Material/Subgrade command under Tools for more on targets.

**Keyboard Command:** set_digit_other
**Prerequisite:** none
Digitize Point

This command allows you to digitize individual points one at a time. The first time it prompts you the Digitize Points Dialog for entering point symbol styles, point prompt settings and number settings, starting point number and layer name. If you want to enter the elevation and description for each point, select Prompt for Descriptions and Prompt for Elevations. After having digitized a point, you can continue to digitize next point by picking the point on the drawing. The command defaults to the last layer name, point symbol, elevation, description and the last point number plus 1. If you have finished digitizing points, press Enter to finish.

Prompts

Digitize Points Dialog
Specify a layer name and select the point symbol, point prompt settings and number settings.

Pick point to create (Enter to end): pick a point on the drawing
Select/ Enter Point Elevation <>: enter the elevation or type <Select> to select the elevation text on the screen
Enter Point Description <>: enter the point description
Result like "N: 1231.16 E: 1099.17 Z: 30.00" would be display on the command line, and a point would be drawn on the screen with the text of its number, elevation and description.

Pick point to create (Enter to end): pick next point or press Enter to finish digitizing points

Keyboard Command: dig_pt
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize Spot Elevation

This command allows you to label points with their elevation. The point can either be digitized from a drawing, picked on a screen or specified by a point number. The command first prompts you the Label Spot Elevation Dialog for entering layer name, label prefix and suffix and symbol types etc. Click OK to start. After specifying the point, the command prompts you to enter the elevation if its elevation is unknown and then pick an angle from the location of the point to label the elevation. You can repeat labeling points until you press Enter to finish.
Prompts

Label Spot Elevation Dialog
Specify a layer name, label prefix and suffix and select the spot symbol.

Point to Label?
Pick point or point number: 2 (enter a point number)
PointNo. Northing(Y) Easting(X) Elev(Z) Description
2 1231.16 1099.17 30.00 bb

Note: if the point number you entered is not in the drawing, you will be prompted again to pick point or enter a point number.

Elevation <30.00>: press enter
Pick angle for label: pick an angle from the spot
Point to Label (ENTER to End)?
Pick point or point number: pick a point on the drawing

Elevation <0.000>: enter elevation
Pick angle for label: pick an angle from the spot
Point to Label (ENTER to End)?
Pick point or point number: press enter to finish

Keyboard Command: labspot
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize 2D Polyline

A 2D polyline is a line of connected points that have the same elevation. This command lets you digitize a 2D polyline by picking points along the lines on the drawing. It prompts you first the Polyline 2D Options Dialog for entering the layer name. Prompt For Polyline Elevation option allows you to enter the elevation for each polyline, otherwise all 2D polylines have 0.0 elevation. Auto-Zoom mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points. There are three ways to enter a layer name, Use current drawing layer, Select from a list of layer name, or Pick an entity on the screen to get its layer name. While digitizing a polyline, the command keeps prompting you to either pick the next point or press 0 to create an Arc until your press Enter to finish digitizing. Press A
on the puck or enter Close on the keyboard to close the polyline on itself. You can define an Arc by Radius, Arc length, Chord length, Delta angle, or by simply picking 3 points along the arc. If at any point you make a mistake, press B on the puck or enter Undo on the keyboard to remove the mistake and then continue to digitize. After finishing a polyline, the command prompts you to digitize another polyline until you press B or enter No.

Prompts

**Polyline 2D Options Dialog**
Enter the layer name and select the options of Prompt For Polyline Elevation and Auto-Zoom mode etc.

Enter default elevation <0.00>: 100
First point: pick a point on the drawing using puck
Segment length: 0.00, Total length: 0.00
Arc[0]/Close[A]/Undo[B]/Osnaps.[.]Pick next point (Enter to end): pick next point
Segment length: 119.03, Total length: 119.03
Arc[0]/Close[A]/Undo[B]/Osnaps.[.]Pick next point (Enter to end): pick next point
Segment length: 115.23, Total length: 234.26
Arc[0]/Close[A]/Undo[B]/Osnaps.[.]Pick next point (Enter to end): press 0
[Radius[0]/Second pt[A]/Undo[B]/<Pick Endpoint>]: press A
Second point or point number: pick a point along the arc
Endpoint or point number: pick the last point along the arc
Segment length: 500.82, Total length: 735.08
Arc[0]/Close[A]/Undo[B]/Osnaps.[.]Pick next point (Enter to end): pick next point
Segment length: 115.23, Total length: 850.31
Close[A]/Undo[B]/Pick next point (Enter to end): press enter to finish digitizing or press A to close the polyline
Digitize Another FINAL Polyline [Yes(A)/<No(B)>]? press A on the puck or enter Yes on the keyboard to digitize next 2D polyline, press B on the puck or enter No on the keyboard to finish digitizing 2D polyline.

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

**Keyboard Command:** dig_2dp
Digitize 3D Polyline

A 3D polyline is a line of connected points that have various elevations, and the slope between points is constant. It can be used in defining pads, excavations, drainage ditched and slopes from proposed design features to meet existing site conditions. This command lets you digitize a 3D polyline by picking points along the lines on the drawing. It prompts you first the Polyline 3D Options Dialog for entering the layer name. Elevation Adder allows you to truncate the elevations you have to enter in by add a given amount to them. There are five ways to enter elevations: known elevation of the point, interpolate, slope from previous point, ratio from previous point and degree from previous point. You can choose one of the methods between picking points. Auto-Zoom mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points. While digitizing a polyline, press A to interpolate the elevation or B to enter it in. The command keeps prompting you to either pick the next point or press 0 to create Arc cords until you press Enter to finish digitizing. Press A on the puck or enter Close on the keyboard to close the polyline on itself. You can define Arc cords by Radius, Arc length, Chord length, Delta angle, or by simply picking 3 points along the arc. You can also use the OSNAP command to pick points by pressing the decimal [.] button on the digitizer puck. If you make a mistake, press B on the puck or enter Undo on the keyboard to remove the mistake and then continue to digitize. After finishing a polyline, the command prompts your to digitize another polyline until you press B or enter No.

Prompts

First point:
Interpolate[A]/screen Pick/<Elevation[B]> <0.00>: 256
Z: 256.00
Arc[0]Close[A]/Undo[B]/Osnap[.]//Pick next point (Enter to end): Pick point
Slope/Ratio/Interpolate[A]/Degree/screen Pick/<Elevation[B]> <256.00>: A
Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]//Next point or elevation<Interpolate>: Pick point
This point elevation will be interpolated upon completion.
Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]//Next point or elevation<Interpolate>: 279
Z: 279.00, Hz dist: 30.01, Slope dist: 37.81, Slope: 76.6% Ratio: 1.3:1
Arc[0]Close[A]/Undo[B]/Osnap[.]//Pick next point (Enter to end): Press Enter
Z: 279.00, Hz dist: 24.18, Slope dist: 24.18, Slope: 0.0% Ratio: 0.0:1
Arc[0]Close[A]/Undo[B]/Osnap[.]//Pick next point (Enter to end): A
Digitize Another EXIST_PLINE Polyline [Yes(A)/<No(B)>]? B
<Tablet Off>

Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Keyboard Command: dig_3dp

**Digitize Rectangle**

This command enables you to quickly create rectangles while digitizing. In the dialog, you can pick to set elevations to the rectangles, otherwise all rectangles will have 0.0 elevation. The Elevation Adder will be added to the value you enter in for the prompt "Enter polyline elevation <0.00>:". For example, if you know all the rectangles you are creating are in the 200s for elevation, you can put in this value for the Elevation Adder and simply put 46, 54, 57, etc. when prompted, and your rectangles will end up with the elevations of 246, 254, 257 etc. There are three ways to enter a layer name, Use current drawing layer, Select from a list of layer name, or Pick an entity on the screen to get its layer name. Auto-Zoom mode would automatically zoom the display to center around the last point when you get near the edge of the screen while picking points.

![Digitize Rectangle dialog](image)

Annotate closed pads will label your rectangles according to the Settings button/dialog shown below:

![Label Pad Elevation dialog](image)

In this dialog, you can enter in a Prefix or a Suffix to the elevation, and determine the labels position, orientation, precision out to 5 decimal places, its layer, and text size.

**Prompts**
Target surface: Design
Digitize Rectangle Dialog Make any chances you desire in the above dialogs.
Enter polyline elevation <0.00>: 200

First point: pick a point on the drawing using puck
Segment length: 0.00, Total length: 0.00
Close[A]/Undo[B]/Osnap[.]Pick next point: pick next point
Segment length: 1105.96, Total length: 1105.96
Close[A]/Undo[B]/Osnap[.]Pick next point: pick next point
Segment length: 426.83, Total length: 1532.79, Area: 236021.59
Close[A]/Undo[B]/Osnap[.]Pick next point (Enter to end): After 3 points you can press (A) for Close to create a rectangle
Digitize Another FINAL_PAD Polyline [Yes(A)/<No(B)>]? B for No

Prerequisite: a digitizer
Keyboard Command: DIG RECT

Digitize Perimeter
Perimeter is a 2D polyline that all points on it have the same elevation. It can be used as boundary polyline of your targets on your drawing. This command allows you to digitize a perimeter by picking points on the drawing. While digitizing a polyline, the command keeps prompting you to pick next point until your press Enter to finish digitizing, or press A on the puck or enter Close on the keyboard to close the polyline on itself. If you make a mistake, press B on the puck or enter Undo on the keyboard to remove the mistake and then continue to digitize. After finishing a perimeter, the command prompts your to digitize another polyline until you press B or enter No.

Prompts
First point: pick a point on the drawing using puck
Segment length: 0.00, Total length: 0.00
Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Segment length: 104.27, Total length: 104.27
Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Segment length: 153.14, Total length: 257.41
Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Segment length: 104.89, Total length: 362.30
Close[A]/Undo[B]/Pick next point (Enter to end): press Enter to finish the perimeter, or press A to close the perimeter
Digitize Another PERIMETER Polyline [Yes(A)/<No(B)>]? press A or enter Yes to continue digitizing another perimeter, press B or enter No to finish digitizing perimeters.

Keyboard Command: dig_perim
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize Areas
This command allows you to find an area in digitize mode. With the puck, pick around the area you wish to calculate. If Draw Perimeter Polyline is toggled on then the linework of your perimeter will be displayed. You can then set the Layer Name and choose to label the Perimeter and Area and enter in an Area Description. You can also set the area you created as a Boundary, Topsoil, or Area of Interest.
Prerequisite: a digitizer

Keyboard Command: dig_area

**Digitize Contour Polyline**

A contour is a line of points with a constant elevation, representing the natural contour of the site. In Takeoff, there are two layer targets: Existing Ground Surface and Design Surface. Contour Polyline has two sub-command to digitize contour lines into Existing Contour and Final Contour layers directly for assigning them easily into Existing Ground Surface and Design Surface in the future analysis.

There are two ways to digitize contour lines: sketch mode or point mode. You can start digitizing a contour with one mode and switch to the other during digitizing the contour. Sketch mode uses more points than pick mode. In general, we recommend using pick mode to digitize the straight parts of lines because it reduces the number of points and speeds up Takeoff’s calculations, but using sketch mode to digitize the curved parts because it is fast and accurate.

This command lets you digitize contours as polylines one at a time. The first time it prompts you the Digitize Contours Dialog. Enter the layer name or select it from a list of existing layer. Look at your plans and determine an elevation interval that is between most of the contours and enter it in the Elevation Interval field. You are able to modify both the value and the direction of the elevation interval between digitizing contour lines, using the buttons on the puck. To have Takeoff automatically close contours whose beginning and ending points are within a specified range, check the Auto Detect Close Contour. Draw Labels would draw the elevation at the starting point of the contour. In Pick mode, if you want the Takeoff to automatically zoom the display to center around the last point when you get near the edge of the screen while picking points, check the Auto Zoom Center. Click OK to start digitizing.

If this is your first time digitizing a contour, you are defaulted to the Pick Mode digitizing, otherwise you would be defaulted to the last digitize mode. If you want to use the other digitize mode, press 0 on the puck or enter 0 from the keyboard. Place your cursor at one end of the contour line and begin digitizing the line. While digitizing a line, you can force a contour to close on itself by pressing A on the puck to end the contour and connect the last point to the first point, remove a mistake by pressing B on the puck, or switch to the other digitize mode by pressing 0. During Sketch Mode digitizing, you can stop digitizing by pressing Pick or Enter button on the puck, take some rest or changes, and start sketching again. At the end of the contour line, press Enter on your puck or keyboard. The contour is completed, and the elevation for the next contour is automatically incremented. You would be asked to digitize next contour. If you press A on the puck or enter Yes on the keyboard, you can digitize another contour, or press B on the puck or enter No on the keyboard to finish digitizing contours.
**Prompts**

Digitize Contours Dialog
Enter Layer Name, Elevation Interval, and toggle on/off Auto Detect Close Contour etc.
Increment(1.00)[A]/Direction(+)[B]/Elevation <573.00>: 450 (enter elevation or press Enter to accept current value)
Start Digitizing...
Sketch[0]/Pick the first point: pick a point to start Pick Mode digitizing (press 0 to switch to Sketch Mode)
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): 0 (press 0 on the puck or enter 0 on the keyboard to use Sketch Mode)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B (undo the last point)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): B (undo the last point)
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): pick and drag again
Drag to digitize (Pick or press Enter to stop sketching)... pick or press Enter to stop sketching
Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end): 0 (press 0 on the puck or enter 0 on the keyboard to use Pick Mode)
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): pick next point
Sketch[0]/Close[A]/Undo[B]/Pick next point (Enter to end): press Enter to finish digitizing
Digitize Another Contour [<Yes(A)>/No(B)]? B (press B to finish digitizing)

**Prerequisite:** Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.
**Keyboard Command:** digcont_exist, digcont_final

**Digitize Sections**

This command allows you to digitize section lines and store the section data in the section file you have specified. The command first prompts you the Digitize Section Dialog. Enter the section file name and determine if you want to digitize second and third sections at the same station. Look at your plans and determines the station interval, which is used to automatically default to the next station value when digitizing a series of stations. If the grids at all the stations have the same base elevation, toggle on Use Fixed Base Grid Elevation. You can also toggle on Interpolate Zero Offset Elevation, Prompt for Subgrades, Prompt for Save for Each Section and Use Beeps with Prompts. Surface Snap Tolerance sets the maximum distance that the program will automatically snap the tie back point between the subgrade and design surface. **Preview Method** offers 2 ways to view the sections as you digitize. "Graphic Dialog" displays the section data in a grid dialog and is best when digitizing from paper plans. "Draw on Drawing" draws 2D polylines in your CAD drawing and is best when digitizing over an Image in your drawing.
"Keep Drawing Preview" will leave the 2D polylines in your CAD drawing (having this checked off will erase the 2D polylines after each station). Click OK to start digitizing.

Takeoff prompts you to calibrate the section sheet before you digitize the section lines. You pick three points and specify their offsets to the centerline and elevations in order to determine the horizontal and vertical intervals. Corners on the section grid are preferred reference points. Place your cursor at one end of the section line and begin digitizing the line. While digitizing a line, you can remove a mistake by **pressing A** on the puck or **entering Undo** on the keyboard. At the end of the section line, **press Enter** on your puck or keyboard. The station is completed, and the station value is automatically incremented. The command would prompts to digitize next section. You can **press A** on the puck or **enter Exit** on the keyboard to finish digitizing. If you want to continue to digitize next section, **press Enter** or enter the new station number. For every station after the first one, you can calibrate the grid sheet by picking one reference point and specify its offset and elevation. After you digitize the section lines on your drawing, all the section data would be saved in a section file (.sct).

**Prompts**

**Digitize Section Dialog**
Enter Section File Name, Station Interval, and toggle on/off Use Fixed Base Grid Elevation etc.

**Section station to digitize <0.000>:** press Enter to start with station 0.0 or enter a station number

**Calibrate section sheet**

**Pick First section sheet reference point:** pick a grid point of this station on your drawing

**Enter offset <0.0>:** press Enter to accept the offset or enter the offset of the point to the centerline

**Enter elevation:** 1030 (enter the Elevation of the reference point)

**Pick Second section reference point:** pick the second grid point

**Enter offset:** 0 (enter the offset of the point to the centerline)

**Enter elevation:** 1040 (enter the Elevation of the reference point)

**Pick Third section reference point:** pick the third grid point

**Enter offset:** 50 (enter the offset of the point to the centerline)

**Enter elevation:** 1040 (enter the Elevation of the reference point)

3 calibration points

Transformation type: Orthogonal Affine Projective
Outcome of fit: Success Exact Impossible
RMS Error: 11.49
Standard deviation: 2.38
Largest residual: 14.08
At point: 2
Second-largest residual: 14.08
At point: 1
Digitize break point for DRAWING1 section 0.000 (Enter to end): pick a point on the section line
Offset: -39.81 Elev: 1028.80
Digitize break point for DRAWING1 section 0.000 (Undo[A],Enter to end): pick a point on the section line
Offset: -9.94 Elev: 1030.03
Digitize break point for DRAWING1 section 0.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 49.44 Elev: 1034.93
Digitize break point for DRAWING1 section 0.000 (Undo[A],Enter to end): press Enter to finish
Save changes to DRAWING1 section 0.000 [<Yes(A)>/No(B)]? A (press A or B)
Exit[A]/Section station to digitize <50.000>: 200 (enter next station number)
Calibrate next section
Pick section reference point: pick a grid point of the station on your drawing
Enter offset <0.00>:; press Enter to accept the offset or enter the offset of the point to the centerline
Enter elevation <1030.00>: 1020 (enter the Elevation of the reference point)
Digitize break point for DRAWING1 section 200.000 (Enter to end): pick a point on the section line
Offset: -40.40 Elev: 1008.07
Digitize break point for DRAWING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: -5.38 Elev: 1019.98
Digitize break point for DRAWING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 27.86 Elev: 1030.02
Digitize break point for DRAWING1 section 200.000 (Undo[A],Enter to end): pick a point on the section line
Offset: 50.33 Elev: 1035.80
Digitize break point for DRAWING1 section 200.000 (Undo[A],Enter to end): press Enter to finish
Save changes to DRAWING1 section 200.000 [<Yes(A)>/No(B)]? A (press A or B)
Exit[A]/Section station to digitize <250.000>: A (press A to finish or enter the station number to continue)

Keyboard Command: digxsec
Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.

Digitize End Areas

There are two types of end areas: cut area and fill area. This command allows you to digitize both cut area and fill area on the drawing and writes data to a .ew file. The command first prompts you to calibrate the section sheet by picking three points and specify their offsets to the centerline and elevations in order to determine the horizontal and vertical intervals. Corners on the section grid are preferred reference points. Then it prompts you to digitize the cut area and fill area respectively. Place your cursor at one end of the end area and begin digitizing the outline of the area. At the end of the section line, press Enter on your puck or keyboard. The end area is completed, and its area is printed on the command line, and you are prompted to digitize next end area. After you finish all the end area at one station, accumulated cut area and fill area are computed and printed out on the screen. All data of cut area and fill area at every station would be saved in the area file (.ew) that you have specified.

Prompts

Calibrate section sheet
Pick First section sheet reference point: pick a point on the drawing
Enter offset <0.0>: press Enter to accept the offset (or enter the offset of the point to the centerline)
Enter elevation: 1020 (enter the Elevation of the reference point)
Pick Second section reference point: pick a point
Enter offset: 0 (enter the offset of the point to the centerline)
Enter elevation: 1030 (enter the Elevation of the reference point)
Pick Third section reference point: pick a point
Enter offset: 50 (enter the offset of the point to the centerline)
Enter elevation: 1030 (enter the Elevation of the reference point)

3 calibration points
Transformation type: Orthogonal Affine Projective

Outcome of fit: Success Exact Impossible
RMS Error: 11.69
Standard deviation: 2.40
Largest residual: 14.29
At point: 2
Second-largest residual: 14.29
At point: 3

Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 0*(0.211129 1030.76)
Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 1*(11.5804 1030.49)
Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 2*(17.8643 1030.73)
Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 3*(19.0216 1032.35)
Digitize cut area (Enter to end): pick a point that is on the outline of the cut area, 4*(-0.777246 1030.75)
Digitize cut area (Enter to end): press Enter to finish

End area: 17.2312
Accumulated Cut Area: 17.2312

More Cut Areas [Yes(A)/<No>(B)]? press A to digitize more Cut Areas, or press B to finish digitizing Cut Areas.
Accumulated Cut Area: 17.2312

Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 0*(-18.9614 1029.65)
Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 1*(-18.1315 1030.75)
Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 2*(-11.9592 1030.49)
Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 3*(-2.06761 1030.72)
Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 4*(-10.0082 1030.01)
Digitize fill area (Enter to end): pick a point that is on the outline of the fill area, 5*(-18.531 1029.67)
Digitize fill area (Enter to end): press enter to finish

End area: 8.64646
Accumulated Cut Area: 8.64646

More Fill Areas [Yes(A)/<No>(B)]? press A to digitize more Fill Areas, or press B to finish digitizing Fill Areas.
Accumulated Cut Area: 8.64646
Total Cut Area: 17.2312
Total Fill Area: 8.64646

Store data to file [ <Yes>(A)/<No>(B) ]? press A or B
Opened file: C:\Program Files\Carlson TakeOff 2004\DATA\Drawing1.ew
Station Number: 1 (enter Station Number)
Data Stored in file: C:\Program Files\Carlson TakeOff 2004\DATA\Drawing1.ew
Digitize another station [ <Yes>(A)/<No>(B) ]? B (press A or B)

Prerequisite: Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Have done tablet calibration for current drawing.
Keyboard Command: digendar
Draw Raster Image

This command inserts an Image file into your current drawing. After selecting the file you wish to draw, the following dialog is shown:

The name of the file is shown at the top with a preview of the file shown below. To select a different file, click on the Browse button. Path Type can be set to the full (absolute) path, the relative path to the image file, or No Path, the name of the image file (the image file must be located in the same folder as the current drawing file). If the scale factor is known, you can enter it under Scale.

If the scale factor is unknown, it is recommended to use the default scale factor of 1 and adjust the Scale with Edit > 2D Scale once the Image is inserted and a scale factor can be determined. Specify On-Screen allows you to input the scale at the Command prompt. Insertion Point specifies the insertion point for the selected image file. Specify On-Screen is the default. The default insertion point is 0,0,0.

Specify On-Screen Directs input at the Command prompt or the pointing device. If Specify On-Screen is unchecked, enter the insertion point as X, Y, and Z coordinate values Rotation specifies the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value at the Command prompt. If Specify On-Screen is unchecked, enter the rotation angle value in the dialog box. The default rotation angle is 0.

Below is list of Images that can be inserted into the drawing. For PDF files, use the Import PDF File (loadpdf) command available in Carlson Takeoff.
**Prompts**

**Specify the insertion point:** pick on the screen or typing in a coordinate (Example: 1000,1000).

**Specify rotation angle:** To accept the default value displayed, press Enter, or enter the rotation angle (Example: 90).

**Specify scale <1.0>:** To accept the default value displayed, press Enter, or enter a scale factor. If the scale factor is not known, which is typical, accept the defaults to this prompt. The proper scale factor can be determined by running Inquiry>Standard Distance on a known distance on the site (ie, the side of a building or the distance across the road). If the side of a building is labeled as 60' and Standard Distance reports it is at 120', then the Scale factor is 0.5 (60/120). Run Edit>2D Scale, select the imported objects, specify a base point of 0,0 and use the Scale Factor you determined with Standard Distance to scale the entities correctly.

After the command has imported the Image file, run View > Zoom > Extents to see the converted entities.

**Pulldown Menu Location:** Raster > Draw Raster Image

**Keyboard Command:** imageattach

**Prerequisite:** None

---

**Set Raster Image**

The Raster pull-down has several commands for manipulating images. However, these commands can only work with one image at a time. Set Raster Image determines which image in a drawing is "current" to edit. Simply run the command and select the image.

**Prompts**

**Command:** rassel

**Select image:** Pick on the image (often you will need to pick on the boundary of the image to select it)

**Image selected. Image file:** pdf1.bmp

**Pulldown Menu Location:** Raster > Set Raster Image
Keyboard Command: rassel
Prerequisite: an image in the drawing

**Raster Edit Options**

General Settings for working with images can be found in the command Raster Edit Options. Defaults are shown below.

![Raster Editor Options](image)

**Pixels to skip:** This setting applies to the Trace Line and Trace Polyline commands. As the program determines where to draw the new linework, it can “skip” or pass over a given amount of pixels who's color does not match the rest of the linework that is being processed. This allows for longer length polylines to be created on poor quality images. A larger amount of pixels to skip will typically create longer length new linework.

**Line** and **Polyline layer** determines the Layers for the new linework.

**Close polyline tolerance (pixels):** While running the Trace Polyline command, this setting will automatically close the polyline if you select an point within the defined tolerance from the starting point.

**Contour interval:** In the Contour Mode of Trace Polyline, this setting determines the value to add or subtract to polyline elevations.

**Elevation Mode:** Zero, Contour, or Prompt. By default, Trace Polyline creates linework at Zero elevation. **Contour Mode** speeds up elevating multiple polylines by adding (or subtracting) the Contour interval to the previous elevation value. **Prompt Mode** allows the user to specify the elevation of each polyline created.

**Thicken min surrounding pixels (1-8):** When running the "rasthicken" command (type-in only, not in pull-down menu), the routine looks at the surrounding pixels of an individual pixel and will change the color of that individual pixel to the surrounding pixels if minimum amount is met. The lower the number, the more "thickening" or densifying will occur.

**Thicken pass count (1-20):** This is the number of times the "rasthicken" command (type-in only, not in pull-down menu) will run in a selected area. The greater number of passes, the more "thickening” or densifying will occur.

**Draw new linework** will update the source Image file with the new linework you create through "Trace Line" or "Trace Polyline".
Erase existing linework will remove linework segments from the source Image file as you trace over those segments.

**Pulldown Menu Location:** Raster > Raster Edit Options  
**Keyboard Command:** rasopts  
**Prerequisite:** none

---

### Clear Strata Surface

Trace Line will convert a line in an image into a single CAD polyline. If an image is "current" through the Set Raster Image command, simply run **Trace Line** and click on a line in the image. In the command line, you will see the **Line Length**, **Angle**, and **Thickness** reported for the new polyline. The command line will also prompt you to change the **Angle**, **Length** or **Reverse** the direction the new polyline if desired. To accept the new line press Enter. To cancel, type C or press Esc.

Different images have different resolutions or quality to them. To account for this, you can adjust the parameters that the program tries to recognizes linework in an image with **Edit Raster Options**. Here is also where the default **Layer** for the new polyline is determined.

#### Prompts

- **Pick a point for line (Enter to end):** Select a line in the image  
  - Line Length=780.00 Angle=269°32'47" Thickness=5  
- **Enter to accept line or [Angle/Reverse/Length/Cancel]:** Type in the first letter in a word to adjust that element of the new polyline. For example, typing in "A" would allow you to adjust the Angle.

**Pulldown Menu Location:** Raster > Trace Line  
**Keyboard Command:** rasline  
**Prerequisite:** Set Raster Image

---

### Clear Strata Surface

Trace Polyline will convert linework in an image into a CAD polyline with multiple vertices. If an image is "current" through the Set Raster Image command, run **Trace Polyline** and name or select the Layer for the new polyline. Once in the command, typing "O" for **Options** will open up the Edit Raster Options dialog.
Here you can determine the Pixels to skip. As the program determines where to draw the new linework, it can "skip" or pass over a given amount of pixels who's color does not match the rest of the linework that is being processed. This allows for longer length polylines to be created on poor quality images. A larger amount of pixels to skip will typically create longer length CAD linework. However, if the image linework is mostly solid, then the pixels to skip should be a smaller amount.

Also in this dialog the user can determine the Elevation Mode: Zero, Contour, or Prompt. By default the polyline is set to Zero elevation. Contour Mode speeds up elevating multiple polylines by adding (or subtracting) the Contour interval to the previous elevation value. Prompt Mode allows the user to specify the elevation of each polyline created. For a full explanation of this dialog, refer to the Edit Raster Options entry in this manual.

Pick Segment will convert linework in the image into a new polyline. Unlike the Trace Line command, multiple segments can be selected one after the other to create a continuous polyline with multiple vertices. Manual Point allows you to pick a Manual point or Snap nearest point to start the new polyline. A manual or "free" point can be anywhere in the CAD environment. A Snap nearest point is anywhere along linework in the image.

Prompts

Pick segment or [Options/Manual point/Continue] (Enter to end): pick on linework in the image or type "m" for Manual point
Pick manual point or [Snap nearest] (Enter to end): if you typed "m" you have the option to pick a "free" point or type "s" to snap a point
Pick manual point using snap nearest or [No snap] (Enter to end): pick on linework in the image to snap to
Pick segment or [Manual point/Undo/Close] (Enter to end): Undo will remove the last segment created, Close will create a closed polyline

Pulldown Menu Location: Raster > Trace Polyline
Keyboard Command: raspline
Prerequisite: Set Raster Image
**Raster Nearest Snap**

Similar to the standard Object or Entity Nearest Snap with CAD entities, **Raster Nearest Snap** will snap to the nearest point on a linework segment or point in an Image. This command can be used with Draw commands such as Draw > 2D Polyline.

**Pulldown Menu Location:** Raster > Raster EndPoint Snap  
**Keyboard Command:** rnea  
**Prerequisite:** most Draw commands

---

**Raster EndPoint Snap**

Similar to the standard Object or Entity EndPoint Snap with CAD entities, **Raster EndPoint Snap** will snap to the closest endpoint of a point or linework segment in an Image. This command can be used with Draw commands such as Draw > 2D Polyline.

**Pulldown Menu Location:** Raster > Raster EndPoint Snap  
**Keyboard Command:** rend  
**Prerequisite:** most Draw commands

---

**Merge Raster Files**

This command merges bitmaps or other images (not pdf-based, unless the pdf has been turned into an image). First, run "Set Left Image" and "Set Right Image" to determine the files to merge. Next, pick identical control points on the left side and right side. Zoom in and pick the best that you can. This establishes the scale, rotation, and alignment for the merge. Note: the preview windows are labeled "Left Image" and "Right Image", but the program will merge images "Top" to "Bottom" if the control points are aligned in that orientation.

![Merge Raster Files Image](image)

After establishing control points, click the Merge button and it merges the left with the right side. When you click Save Image, you can save it in a number of distinct forms (typically as a .bmp is sufficient). Notice the program automatically removed the match line text, with no overlap. The key is that your two reference points for scale and rotation, which match, must be at the linear overlap line, because everything to either side is removed automatically.
Originally, the two images overlapped, but now that has been removed.

**Pulldown Menu Location:** Raster > Merge Raster Files  
**Keyboard Command:** rasmerge  
**Prerequisite:** Two or more Images you'd like to combine

---

**Cut Image**

This tool is used to clean up an Image at the extents of a polyline boundary. First, select the inclusion boundary polyline(s) and any exclusion boundary polyline(s). Everything in the Image to the inside of these polyline is removed. Warning: this command will update the Image seen on the screen as well as the source Image.

**Pulldown Menu Location:** Raster > Cut Image  
**Keyboard Command:** rascut  
**Prerequisite:** an Image and a closed polyline

---

**Crop Image**

This tool is used to clean up an Image at the extents of a polyline boundary. First, select the boundary polyline(s). Everything in the Image to the outside of this polyline is removed. Warning: this command will update the Image seen on the screen as well as the source Image.

**Pulldown Menu Location:** Raster > Crop Image  
**Keyboard Command:** rascrop  
**Prerequisite:** an Image and a closed polyline

---

**Remove Speckles**

Images that have been scanned in from paper plans often have unwanted black dots or "speckles" that can be removed with this command. Depending on the image, there is a max speck size that can be set. The larger the size indicated, the more specks will be removed. You can specify the area to remove specks from based on the entire drawing or by a closed inclusion polyline. Warning: this command will update the Image seen on the screen as well as the source Image.
Undo Raster Edit

Undo Raster Edit will revert an Image back to its original form (both on-screen and source) from changes made by: Image Cut, Image Crop, Remove Speckles, Trace Line or Trace Polyline. It will not remove any polylines created by Trace Line or Trace Polyline.

Drillhole Menu

This chapter provides information on using the commands from the Drillhole menu to produce, import and edit drillhole strata settings, place drillholes, make strata surfaces and draw strata surfaces.

Drillhole Strata Settings

This command selects drillhole symbols, defines strata, and determines how you place drillholes.

**Note:** The order in which the Strata are defined in the Strata Definitions list will be the default order for the strata when you create new drillholes through **Place Drillhole**.

The dialog box below shows the layout of the Drillhole and Strata Settings.

<table>
<thead>
<tr>
<th>Strata Name</th>
<th>Model</th>
<th>Method</th>
<th>Density</th>
<th>Swell</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOPSOIL</td>
<td>Elevation</td>
<td>InvDist-2</td>
<td>0.000</td>
<td>1.000</td>
</tr>
<tr>
<td>DIRT</td>
<td>Elevation</td>
<td>InvDist-2</td>
<td>0.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>
• **Select Symbol**: Select a symbol to represent the drillhole location on the screen.
• **Symbol Name**: This name corresponds to the symbol selected.
• **Symbol Size**: This field can be edited to adjust the symbols size displayed on the screen.
• **Strata Definitions**: This is not directly editable. Select the Strata you are interested by highlighting it, then select the Edit button.
• **Add**: This option adds additional strata to the available Strata name list. See Edit Strata dialog box below.
• **Edit**: Similar to Add, this option is available to make changes to the Strata, including adding a swell factor.
• **Strata Name**: The name of the strata.

**Density (lbs/ft³)**: The Strata Density field is the default density used to calculate strata tons. Density is strata-specific.

• **By Depth**: This option will generate a strata surface by modeling the strata depth values in the drillholes. This strata surface will follow the existing ground surface at the model depth.

• **By Strata Elevation**: This option will generate a strata model that connects strata irrespective of the upper surface elevation changes.

• **Strata Modeling Method**: There are three ways to model strata by Inverse Distance to the 2nd power, 3rd power, or by linear least squares.
Inverse Distance (Power 2 and Power 3) Modeling Method
Inverse distance calculates the strata model by assigning weights to the drillholes. The strata model calculated by inverse distance are a weighted average of the drillhole data. Inverse distance will not carry trends and the calculated surface model will never be higher than the highest drillhole elevation. Likewise the calculated strata model will never be lower than the lowest drillhole elevation. The weights are proportional to the inverse of the distance between the point to be estimated and a drillhole. Closer drillholes are weighted more than points farther away. The inverse distance can be calculated to the second or third power which are \( \frac{1}{d^2} \) and \( \frac{1}{d^3} \) respectively. Inverse Distance - Power 3 will weigh drillholes less that are further away.

Linear Least Squares Modeling Method
The linear least squares method finds the least squares best fit plane across the surface model. The least squares routine weights each drillhole by inverse distance so that closer points are weighted more than points farther away. So the best fit plane varies at different points on the surface. The linear least squares method extrapolates trends very well. Least squares will trend and allows for data points that are new highs and lows, that don't appear in the original drillhole data.

- **Remove:** This will remove a strata name from the available strata.
- **Move Up:** This option will move the selected strata name up one place in the strata name list.
- **Move Down:** This option will move the selected strata name down one place in the strata name list.
- **By Strata Elev:** This method will generate a strata surface by modeling the strata elevation values from the drillholes. This strata surface is independent of the existing ground surface.
- **Place Drillhole Prompts:** If Depth is selected, then when you run Place Drillholes you will be prompted for the depth of each strata in your drillhole. If Thickness is selected, you will be prompted for the thickness of each strata. If Dialog is selected, you will go straight into the Place Drillhole dialog when you create a drillhole.
- **Default Last Thickness:** Will set the thickness of your bottom strata to the same amount for all your drillholes.

**Keyboard Command:** tk_chdef
**Prerequisite:** strata information

Drillhole Import
This command allows you import existing drillhole files. When you select Drillhole Import from the Drillhole menu, a command prompt shows:

"Use separate drillhole and strata files [Yes/<No>]?"  If you have two separate files, one with strata info, and the other file has drillhole locations, select Yes. If you enter Yes, the dialog box below appears.

This command creates drillholes from the data contained in text files. Currently there are many company-specific formats. A Drillhole Data File Formatter that is flexible to handle almost any drillhole text file format is below. The format to use is chosen in the dialog shown here.
The import text can have comma delimited, space delimited or fixed width columns of data. All the data for a record should be on one row. For the fixed width format, choose the Fixed Width toggle and then enter the column numbers separated by spaces in the edit box. For example, "8 15 24 32".

The Custom format can import all the drillhole and strata data from one text file or the drillhole data from one file and the strata data from another file. The method to use is set at the Use separate drillhole and strata files prompt.

Use the following commands to prepare a file format that will match the *.imp imported file.

- **Add**: Moves the selected entry from Available to Used.
- **Add Attribute**: Allows user input attributes into the Used section.
- **Add Skip**: Adds a "Skip" place holder in the Used List
- **Remove**: Moves a selected item from Used to Available list.
- **Move Up**: Moves the selected item up one place in the list.
- **Move Down**: Moves the selected item down one place in the list.
- **Comma Delimited**: Select this if your *.imp file has commas separating each field.
- **Single space delimited**: Select this if your *.imp has a space separating each field.
- **Tab delimited**: Select this if your *.imp file has tabs separating each field.
- **Fixed widths**: Select this if your *.imp has a defined width of space separating each field.
- **Auto Fixed widths**: Select this to automatically determine the fixed widths that separate each field in the *.imp file.
- **Header Lines to Skip**: If your *.imp file has header lines, enter the number of header lines here.
• **Load:** Takes you to select/brows for your *.imp file.

• **Save:** This command will save your imported file as a *.imp file.

The dialog box below details the drillhole import options.

In addition to the previously listed import commands above, this dialog box also has the following prompts:

• **Avoid Duplicate Strata Names:** Select this to prevent having more than one strata with the same name.

• **Strata on one row:** Select this option if all of your strata info is on one row.

**Keyboard Command:** tk_chimport  
**Prerequisite:** drillhole files

### Place Drillhole

This command allows you to screen pick, enter coordinates or, locate by station-offset the placement of a drillhole.

Go to **Drillhole/Strata Settings, Place Drillhole Prompts**, to determine how you would like to be prompted. When you select **Place Drillhole** from the **Drillhole menu**, the command line prompt shows:

"Station/<Pick Drillhole Location>:" Type in x-y coordinates or move your pointer around the screen to pick the placement of the drillhole. To load a centerline file, press S, select the centerline file to reference, then type in the desired Station and Offset amount. If you are in Dialog Mode defined in **Drillhole/Strata Settings**, once a location has been selected, the following dialog box appears:
Place Drillholes generates drillholes in the drawing that are required to run strata surface application routines. Each drillhole consists of a surface elevation, strata, and optional description(s). Every strata has a name, bottom elevation, thickness. Within a drillhole, the strata names must be unique, but each real-world strata should have the same strata name across all the drillholes. This is because strata surface applications connects together the strata with the same name.

The drillhole data can be entered in the dialog shown here, or if Depth or Thickness Mode is selected under Drillhole/Strata Settings, then the data can be entered in on the command line when you place each drillhole. Make sure to specify the surface elevation and drillhole description. While in Dialog Mode or to change data, use the Edit and Insert/append buttons to enter strata data. The symbols are defined in DrillHole/Strata Settings and drillhole may be changed in Edit DrillHole. Pick Save when done and a drillhole symbol is drawn.

• **Edit:** Make changes to the highlighted strata name. Thickness, Bottom Elevation, Depth.

When placing drillholes, every strata must be assigned a bottom elevation and a thickness. The bottom elevation is the elevation of the bottom of the strata. There are different methods for entering this information.

• **Insert Above:** To add a Strata above the highlighted strata name.
• **Append to Bottom:** To add a strata to the bottom of the available strata name list.
• **Remove:** Removes a strata from the available Strata Name list.
• **Surface Elevation:** This field can be set by you to establish the surface elevation of the drillhole.
• **Drillhole Name:** The name of the drillhole
• **Description:** Drillhole descriptions are intended for storing of drillhole specific information in the drillhole. One general drillhole description is predefined and user may define any number of specific drillhole descriptions. Typical additional descriptions are DRILLER, DATE, TOWNSHIP, and etc. You will be prompted for values of these descriptions in Place DrillHole.
• **Adjust Bottom Elevations:** Will make adjustments to the bottom elevation based on thickness changes.
• **Adjust Next Thickness:** Will adjust the next thickness to hold the bottom elevation unchanged.
• **Save:** This command saves this drillhole as listed.
• **Zoom In:** This increases the magnification of the black view window, cross-section view of the drillhole.
• **Zoom Out:** This decreases the magnification of the black view window, cross-section view of the drillhole.
• **Cancel:** Ends Drillhole placement routine without making changes.

**Keyboard Command:** tk_chplace  
**Prerequisite:** drillhole information

### Edit Drillhole

This command allows you to screen pick an existing drillhole and edit its properties. When you select **Edit Drillhole** from the **Drillhole menu**, a command prompt shows:

"Select Drillhole to edit:" Move your pointer around the screen to pick the drillhole you want to edit. Once a drillhole is picked on the screen, the following dialog box appears:

![Edit Drillhole Dialog Box]

- **Edit:** Make changes to the highlighted strata name. Thickness, Bottom Elevation, Depth.

![Edit Strata Dialog Box]

- **Insert Above:** To add a Strata above the highlighted strata name.
- **Append to Bottom:** To add a strata to the bottom of the available strata name list.
- **Remove:** Removes a strata from the available Strata Name list.
- **Surface Elevation:** This field can be set by you to establish the surface elevation of the drillhole.
- **Drillhole Name:** The name of the drillhole
- **Description:** The screen display description of the drillhole
- **Adjust Bottom Elevations:** Will make adjustments to the bottom elevation based on thickness changes.
- **Adjust Next Thickness:** Will adjust the next thickness to hold the bottom elevation unchanged.
- **Save:** This command saves this drillhole as listed.
- **Zoom In:** This increases the magnification of the black view window, cross-section view of the drillhole.
• **Zoom Out:** This decreases the magnification of the black view window, cross-section view of the drillhole.
• **Cancel:** Ends Drillhole placement routine without making changes.

**Keyboard Command:** tk_chedit  
**Prerequisite:** drillhole information

## Label Drillhole

Label Drillhole can be used to label selected properties from drillholes in the current drawing. The first prompt will ask you to select the drillholes you wish to label. To do this, either window around the drillholes you wish to label or type in "all" enter to select all the drillholes in the drawing. Next, a dialog will appear that gives you control on what is displayed in the Labels.

![Drillhole Text Format Options](image)

On the left side of this dialog are the Available label options for the drillholes. You have control what is shown for each strata surface as well as general drillhole information such as the name and coordinates. Use the arrows in the middle of the dialog to move an Available label option into the Used column on the right. When you do this, the below dialog will appear with more options.

![Exit Text Format](image)
In the Edit Text Format dialog, you can control the Layer, Style, Color, Prefix/Suffix, Decimals, Row Position, and Alignment of text. These items when changed become default the next time the dialog is opened. Here is an example of Drillhole Labels.

Pulldown Menu Location: Drillhole
Prerequisite: Place Drillhole
Keyboard Command: chtext2

Strata Polylines

Strata Polylines define strata elevation or thickness along linework instead of a single point like Place Drillhole. Linework defined as Strata Polylines are incorporated with Drillhole Data to create surface models. Note: Strata surface models can not be made exclusively from Strata polylines, some drillholes need to be placed as well.

Tag Strata Polylines

This command allows the user to select polylines that define a Strata. Pick the Strata from the list or type in the name in the Enter Name field. Any Strata you enter in must match a strata defined in Drillhole/Strata Settings in order for the surface to be created.
After selecting a Strata and pressing enter you will be prompted for the type of polyline.

Type of strata polyline \[<\text{Elevation}>/\text{Thickness}]?\]

Elevation signifies that the $Z$ value for the polyline(s) you are about to select represent the bottom elevation of the previously selected strata. Thickness means that the $Z$ value represents thickness of the strata. Choose one of these options and select the polylines.

**Prerequisite:** Drillhole/Strata Settings, desired polylines  
**Keyboard Command:** stratatag

**Highlight Strata Polylines**

This command allows users to identify Strata Polylines by either picking on a polyline(s) or by searching the entire drawing. The command will then dash the polyline in the plan view.

**Prerequisite:** Tag Strata Polylines  
**Keyboard Command:** highlight_strata_pl

**Identify Strata Polylines**

This command allows users to identify topsoil polylines by picking on a polyline. The command will then report the Strata name and Type (either Elevation or Thickness).

**Prerequisite:** Tag Strata Polylines  
**Keyboard Command:** strataid

**Untag Strata Polylines**

This command allows the user to remove previously tagged Strata Polylines so that they are not included in the
Prerequisite: Tag Strata Polyline

Keyboard Command: stratauntag

**Drillhole Reports**

This command allows you to generate a report of selected drillholes. When you select Reports from the Drillhole menu, a sub-menu choice of **Standard Drillhole Report** or **Custom Drillhole Report**, is displayed.

**Standard Drillhole Report**

If this is selected, several prompts are asked at the command line. They are as follows:

Select objects:

- Add Page break between drillholes [Yes/No]?
- Report Strata depth to [Top/Bottom]?
- Report Strata elevation of [Top/Bottom]?

The report is then displayed accordingly.

**Custom Drillhole Report**

This function allows you to customize your report format.
Prompts:

Command: tk_chreport2  
Select the Drillholes for report.  
Select objects: Specify opposite corner: 271 found  
262 were filtered out.

Keyboard Command: tk_chreport, tk_chreport2  
Prerequisite: drillholes

Make Strata Surface
This command generates multiple strata surfaces based on strata definitions and placements of drillholes. Strata surfaces are generated at the bottom of each strata. These strata surfaces can then be used in other TakeOff commands like Calculate Total Volumes. They can be viewed on screen, through the command Draw Strata Surface.

Note: By observing the command line, one can see the status of each strata surface generation.

Keyboard Command: tk_chgrid  
Prerequisite: Define Drillhole/Strata Settings, Place Drillhole

Clear Strata Surface
This command clears the strata surfaces previously generated with Make Strata Surface. This removes the strata surfaces from processing in other takeoff commands.

Note: This command will not remove the surface from the screen view. You must use the command Erase Strata Surface to remove them from view.
**Keyboard Command:** tk_chclear  
**Prerequisite:** Make Strata Surface

---

**Draw Strata Cut Depth Contours**

This command will draw the **Strata Cut Depth Contours**. This command creates contours for the cut depth between the design surface and strata.

You must have created Strata Surfaces through the **Make Strata Surface** command.

Then select **Draw Strata Cut Depth Contours** from the **Drillhole menu**. You will be prompted to select the Strata from the dialog box below.

![Draw Cut Depth Contours](image)

You can assign a contour interval and contour layer for the contours to be drawn. If **Use Inclusion/Exclusion Perimeters** is checked on you will be prompted for an Inclusion polyline and a Exclusion polyline if needed, otherwise the drawing's Boundary linework will be used.

**Keyboard Command:** tk_chdepth  
**Prerequisite:** Make Strata Surface

---

**Erase Strata Cut Depth Contours**

This command will erase the Strata Cut Depth Contours from the screen display.

**Keyboard Command:** tk_chdepth2  
**Prerequisite:** Strata Cut Depth Contours

---

**Draw Strata Cut Color Map**

This command will generate a map of areas where the design surface cuts into the selected strata.

![Select Strata To Process](image)

---

**Prompts**

Select point for color legend: - Use your pointing device to select the top left corner of where you want the cut color legend to be displayed.
Legend size <10.0>: Screen display size. 
Label all zones or summary [All/<Summary>]? This pertains to the number of elevation labels on the legend.

**Keyboard Command:** tk.chmap  
**Prerequisite:** Make Strata Surface

---

### Erase Strata Cut Color Map

This command will erase all Strata Cut Color information from the screen display.

**Keyboard Command:** tk.chmap2  
**Prerequisite:** Draw Strata Cut Color Map

---

### Draw Strata Surface

This command will display the selected strata surfaces as 3D faces. The bottom elevation of the strata is drawn.

A color can be selected to distinguish each strata.

**Keyboard Command:** tk.chplot  
**Prerequisite:** Make Strata Surface

---

### Erase Strata Surface

This command will erase all strata surface 3D faces from the screen display.

**Keyboard Command:** tk.chplot2  
**Prerequisite:** Draw Strata Surface

---

### Trench Menu

#### Input Trench From Polyline

This command allows you to input a trench sewer network structure from polylines or points. It first prompts you the **Input Trench Line Dialog** where you specify the Trench Type, Trench System, and the System Name. The Individual Profile option lets you input one trench reach at a time and save its information to a profile (.pro). The Connected Network option lets you input all the trench polylines on the drawing, merge them into a trench network structure and save the whole structure to a .sew file. For trenching or utilities without Invert-Ins, uncheck Prompt
For Invert-In Elevation. If you want to set the Rim Elevation to any surface elevations, check on Default Rim Elev to Surface Elev and then use the Surface Button to select the desired .tin or .flt surface file. Prompt For Pipe Wall Thickness allows you to enter in the pipe thickness that will be used in calculating backfill quantities in two prompts: 1) the interior pipe size and, 2) the thickness of the pipe wall. If this is check off, the value in Pipe Wall Thickness will be automatically added to the Pipe Size for backfill volumes. You can also enter in a Structure Width to be considered in the Cut volumes. Pipe Shape determines the prompting so that you can create Circular, Elliptical, or Rectangular pipe. Click OK to start inputting trench structures.

There are two different types of Input Methods in this command: Polyline or Points. Points allows you to pick freely the location of each sewer structure. With the polyline method, Takeoff extracts the coordinates of all the vertices of the polyline to determine the location of the structures. With both methods you are prompted for the starting station number. Takeoff computes the station values based on the starting station number. Next, you are prompted to enter the Manhole ID (Sewer Trench) or Station ID (Pipe Trench), Invert Elevation, Manhole Elevation (Sewer Trench), and Pipe Size or Pipe Group for every station. You can either enter the values manually or select the texts that represent these values on the drawing. When you finish inputting a polyline, the command would ask you for a profile name to store the profile data if you are doing Individual Profile; otherwise the command would ask you to pick next polyline that is in the same trench network.

Prompts:

Pick a polyline that represents a trench reach: pick a polyline on your drawing
Starting Station of trench reach <0.0>: press Enter to accept 0.0 as the starting station or enter a value

For station 0.00 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually

For station 270.22 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to
enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
For station 425.02 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
For station 649.73 ...
Enter/<Select text of Manhole ID>: select the Manhole ID text on the drawing or enter Enter on the keyboard to enter the Manhole ID value manually
Enter/<Select text of invert elevation>: select the invert elevation text on the drawing or enter Enter on the keyboard to enter the invert elevation value manually
Enter/<Select text of manhole elevation>: select the manhole elevation text on the drawing or enter Enter on the keyboard to enter the manhole elevation value manually
Undo/Select/Group/<Enter Pipe Size <0.0000>>: select the pipe size text on the drawing or enter Enter on the keyboard to enter the pipe size value manually or select Group to enter in a Pipe Group
Another Polyline [<Yes>/No]? enter Yes to input another trench reach from a polyline or enter No to finish

At the end of the command, a file opening dialog would be prompted to you to specify a .sew file name to store the trench network structure.

Prerequisite: A drawing with one or more polylines that represent the trench structure.
Keyboard Command: pline_trench

Create Trench Network Structure
This command allows you to create or modify a trench network structure on a drawing. Before you are able to locate the trench structure, the drawing has to be open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. You can locate the trench structure by one of three methods: picking points on the drawing, entering the point number, or specifying the station and offset of a centerline. If you use centerline method, you need to specify a centerline file. After you locate a point on the drawing, you are prompted the Sewer Structure Data Dialog for entering the sewer structure information, such as Structure Name, System Name, Symbol Name, and Elevations. Take a look at the list of the trench points that have been defined. If there is any point that is connected upstream to the current point, you add it to the Upstream Connections list. The Invert Elevation and the Pipe Size fields will be filled with the information of the upstream point. Use Pipe Group allows you to set multiple pipes for the trench run by using a existing or new Pipe Group. Click OK to finish entering the trench structure data. The command will repeatedly ask you to pick a structure point until you hit Enter to finish. The trench network structure data is saved in a .sew file.
Prompts

By Pick:

Locate by pick point, point number or station-offset [<Pick>/Number/CL]? press Enter to do Pick point

Loading edges...
Loaded 4 points and 5 edges
Created 2 triangles

Pick structure location: pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): pick a point
Sewer Structure Data Dialog: enter trench structure information
Pick structure location (Enter to end): press Enter to finish

By station-offset of CL:

Locate by pick point, point number or station-offset [<Pick>/Number/CL]? CL (enter CL to do locating trench structure by station-offset of a centerline)
Specify a centerline file.
Loading edges...
Loaded 4 points and 5 edges
Created 2 triangles

**Structure Station:** 0 *(enter the station number on the centerline)*
**Structure Offset:** 200 *(enter the offset from the centerline)*
**Sewer Structure Data Dialog:** *enter trench structure information*
**Structure Station (Enter to end):** 100 *(enter the station number on the centerline)*
**Structure Offset:** 200 *(enter the offset from the centerline)*
**Sewer Structure Data Dialog:** *enter trench structure information*
**Structure Station (Enter to end):** press Enter to finish

**Prerequisite:** Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface.

**Keyboard Command:** locate_trench

---

**Edit Trench Network Structure**

This command edits the existing trench structure data on the drawing. There has to be a trench network structure that has been created beforehand and its data is store in a .sew file whose name is as same as the drawing name. The command first prompts you to pick a sewer structure on the drawing. If there is no such structure in the .sew file, you would get a error message like this: "Error: unable to locate structure in file C:\temp\takeoff\SANI1x.sew, otherwise this command will restore the trench structure data from the corresponding .sew file and display it on the Sewer Structure Data Dialog for editing. Click OK to confirm your modification. You are prompted to edit another structure point until you press Enter to finish. All modifications are saved in the .sew file.

Set Location will return you to the plain view and prompt you for a new location for the structure by either typing in the coordinates or picking on the screen. In the dialog you can change the Structure Name, Symbol, Width, Depth, and Type. Setting a Structure Template will allow you to set the dimensions of the Structure with a .tch file. See Input-Edit Trench Template for details on creating a .tch file. Here you can also manage how the Structure is connect to other Structures. Under Upstream Connections you will see the Structure(s) currently connected to upstream and a list of available Structures on the right. Pick Add to connect to a Structure you have selected under Available, and Remove to disconnect to any selected Structures. Other options are to edit the Rim Elevation, Invert In and Out, as well as Pipe information between your Structure and the highlighted Upstream Connection. Use Pipe Group allows you to set multiple pipes for the trench run by using a existing or new Pipe Group. Min Cover shows you the depth between the Design Surface and top of pipe. Set Min Cover will adjust your Invert In and Out elevations so that you have at least the value you enter as the Min Cover.

**Prerequisite:** Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

**Keyboard Command:** edit_trench

---

**Trench Spreadsheet Editor**

This command allows you to view and edit existing trench network data in spreadsheet form. Upon running the command, the program will open the .sew file associated with the drawing, or if one has not been established, you will be prompted to select one.
The Trench Spreadsheet Editor allows you to select the Pipe Line you want to edit, or view all the Pipe Lines at once by checking on "Select All Pipe Lines". After selecting a Pipe Line, each segment of the Pipe Line will be displayed as: the downstream connection (Down Junct), upstream connection (Up Junct), the invert in of the downstream manhole (Down Invert), the invert out of the upstream manhole (Up Invert), and the Slope, Length and Pipe Size between the two. Any value between two manholes can be edited except for the Length. Spreadsheet Settings allows you to choose what elements of a segment are displayed.

Click OK to confirm your modification. All modifications are saved in the .sew file.

**Prerequisite:** Sewer Network File  
**Keyboard Command:** edit_trench2

### Remove Trench Network Structure

This command removes the existing trench structure data. There has to be a trench network structure that has been created beforehand and its data is stored in a .sew file whose name is as same as the drawing name. The command first prompts you to pick a sewer structure on the drawing or to select from a List of your Sewer Structures. If there is no such structure in the file, you will get an error message like this: "Error: unable to locate structure in file C:\temp\takeoff\SANI1x.sew, otherwise this command removes the structure from both the drawing and the .sew file immediately. You are prompted to remove another structure point until you press Enter to finish. The removed trench structure points would no longer be found in the .sew file.

#### Prompts

**Select structures to erase by screen pick or name list [Pick>/List]?** Pick to choose from the screen, or List to choose from the below dialog.

**Prerequisite:** Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has
been stored in a .sew file, whose name is as same as the drawing name.

Keyboard Command: remove_trench

---

**Find Trench Network Structure**

This command will center the screen and draw an arrow to the structure you specify.

**Prerequisite:** a Trench Network

**Keyboard Command:** findswr

---

**Export Trench Network Data**

Export to Points

![Export Network To Points dialog box](image)

This command will add points at your trench structures and add them into your coordinate file by either the Rim Elevation or the Invert-Out.

Export to Profiles

![Export Network To Profile dialog box](image)

This command will create a profile file (.pro) of your trench either going Upstream or Downstream. The (.pro) file can then be drawn under Roads->Draw Profile.

**Prerequisite:** a Trench Network

**Keyboard Command:** swr2pts, swr2pro
**Trench Network File Backup**

*Save Trench Network File* saves your trench network as a (.sew) file. *Load Trench Network File* loads a previously saved (.sew) file.

**Prerequisite:** none  
**Keyboard Command:** `save_trench`, `load_trench`

**Plain View Label Settings**

This command allows you to set the labeling for your structures and piping. The below dialog box gives you the option to display the Structure Name, the Rim Elevation, the Invert-In, and Invert-Out. In addition, you can set the Prefixes, Suffixes and labeling location as you so desire. The Use Structure Data Table will create linework around each Structure's labeling.

![Network Label Settings](image)

This below dialog box gives you the option to display the Length, Size, Material, and Slope for you Piping. In addition, you can set the Prefixes, Suffixes and labeling location as you so desire. To specify to which structure the label is meant for, select Arrow On Pipe, Parallel Leader, or None. You can also set the type of linework to draw.

![Network Label Settings](image)
In this dialog you can set the properties for your Symbol and Linework as well as the decimal places to report.

Prerequisite: a trench network
**Keyboard Command:** `swrsetup`

**Draw Trench Network - Plan**
This command draws a trench network structure on the screen, based on the Plan View Label Setting command and the trench network structure data in the `.sew` file whose name is as same as the drawing name. If Takeoff couldn't find such file in the same directory where the drawing locates, nothing would be drawn on the screen.

Prerequisite: A open drawing
**Keyboard Command:** `plan_trench`

**Draw Trench Network Centerline**
This command allows you to draw a branch of the trench network structure as a centerline. There has to be a trench network structure that has been created beforehand and its data is store in a `.sew` file whose name is as same as the drawing name, otherwise you would get a error message like "Error: no data in sewer network file". The command first prompts you the **Draw Sewer Network Centerline Dialog**. Select the Upstream and Downstream Structure for the centerline you are about to create. The Centerline Direction determines from which structure the polyline is drawn. You can also choose to save the centerline data to a `.cl` file with the option of entering in the Beginning Station. In this dialog is the ability to set the Layer name as well. Click OK to draw.
Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

Keyboard Command: drwswrcl

Draw Trench Network - Profile

This command allows you to draw a branch of the trench network structure as a sewer/pipe profile. There has to be a trench network structure that has been created beforehand and its data is stored in a .sew file whose name is as same as the drawing name, otherwise you would get a error message like "Error: no data in sewer network file". The command first prompts you the Draw Sewer Network Dialog. Select the Upstream and Downstream Struct that you want to draw. If you want to draw the existing and final design surface, as well as Strata Surfaces, toggle on Draw Existing Ground Surface, Draw Final Design Surface, and Draw Strata Surfaces options. If your profile is from upstream to downstream, then select the Profile Direction as Downstream, otherwise Upstream. You can also choose to save the profile data to a profile file. Click OK to draw.

Initializing Draw Profile command ...

Draw Sewer Profile Dialog Enter drawing parameters such as Grid scale, text scaler, starting and ending stations etc. for drawing the sewer profile.
Enter general sewer profile settings such as elevations (Rim, Invert-In, Invert-Out) to draw and label.

Use the Manhole tab to define what manhole information is labeled in your trench profile.
Use the Pipe tab to define what piping information is labeled in your trench profile.

The command will find the elevation range of your profile and display it at the top of this dialog. Here you can set the elevation top and bottom of the profile's grid.
Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.

Keyboard Command: profile_trench

Define Pipe Groups

Pipe Groups allow users to define multiple pipes inside a single trench. Pipe Groups can be applied to a Trench Run during the creation of a Trench Network or after the fact with Edit Trench Structure. In the Define Pipe Groups dialog you can Add, Remove, Edit, or Report different Pipe Groups.

Click Add and a blank Pipe Group dialog will appear. Here you can enter in a Name for the Group and Add different types of pipes into the Group. Clicking Edit or Add in the Point Group dialog will bring up the Edit Pipe dialog. Here you can specify the Pipe Shape, Bottom Offset (from the bottom of the Trench), the Size, Width (when needed), and the Wall Thickness of the pipe.

Report in the Define Pipe Groups dialog will bring up the below dialog:
From this dialog you can pick on what you want to report and view it or export it into Excel.

**Prerequisite:** none  
**Keyboard Command:** define_pipe_grp

## Input-Edit Trench Template

This command lets you create a new trench template or modify an existing trench template. It prompts you the **Input-Edit Trench Template Dialog**. If you are modifying a trench template, click the **Load** button on the dialog to open a trench template file and display the template data on the dialog. Enter the dimensions of the trench: bottom offset, trench width and vertical side height. The Edit Trench Benches button will bring up the below dialog, and allows you to enter in up to four benches into your trench.
There are three methods for entering the cut slope, Percent, Ratio and Degree. Choose one of the methods and enter the slope value. Display Sewer Structure allows you to see your pipe or manhole as part of the trench. This is for display purposes only, calculations will be drawn from the pipe size you set in the Trench Network Structure commands. Add Pipe Diameter To Trench Width will increase the size of your trench by the diameter of your different pipe sizes.

If there is a Top Backfill, enter the Material Name, Thickness and if needed Shrink Factor. The thickness of the Top Backfill is assessed from the top of the trench down. There are three trench Bottom Backfill layers that can be defined. Enter the layer label in the material name field, the depth of the layer in the thickness field. The thickness of these values are assessed from the bottom of the trench up. The Middle Backfill Material is any volume between the Top and Bottom Backfills and can fluctuate depending on the depth of the trench. No set thickness can be applied to the Middle Backfill. Click Save or SaveAs to save the template information in a .tch file, and Click Exit to quit this command.

Prompts:

**Input-Edit Trench Template Dialog**
Enter the dimensions of the trench template, save the information to a template file (.tch).

**Prerequisite:** None
**Keyboard Command:** make_trench_tpl

**Draw Typical Trench Template**
This command draws a trench template on the screen. After you select a trench template file (.tch) to draw, a Typical Trench Template Dialog is prompted for entering the layer name, drawing scale, text size scaler and selecting how many decimal points you want. You can also hatch the backfill on the drawing. Click OK to draw the template at the position that you pick on the screen.
Prompts

Pick position to draw template: pick a position on the screen

Prerequisite: None.
Keyboard Command: draw_trench_tpl

Trench Subgrade Areas
The purposes of Trench Subgrades is to assign a different type of trench template when a trench passes under a road, building pad, etc.

Set Trench Subgrade Polylines
Choose a closed polyline that defines the area that you want a different trench template for, ie a building pad polyline.

Prerequisite: None.
Keyboard Command: tag_trench_subgrade

Clear Trench Subgrade Polylines
This command untags selected polylines for trench subgrade use.

Prerequisite: Trench Subgrade Polylines
Keyboard Command: untag_trench_subgrade

Hatch Trench Subgrade Area
This command hatches trench subgrades for easy viewing.

Prerequisite: Trench Subgrade Polylines
Keyboard Command: hatch_trench_subgrade

Erase Trench Subgrade Hatch
This removes previous made trench hatching.

Prerequisite: Trench Subgrade Hatching
Keyboard Command: erase_trench_subgrade
This command calculates the trench volumes. There has to be a trench network structure that has been created beforehand and its data is stored in a .sew file whose name is as same as the drawing name, otherwise you would get an error message like "Error: no data in sewer network file".

The command loads the trench network data and splits them into individual trench lines and displays them on the **Calculate Trench Quantities Dialog**. You can choose to calculate the trench volume of one trench line or several trench lines at a time. You need to set a **Main Template** in order to calculate volumes. To create a template, run **Trench > Input-Edit Trench Template**. The trench cut volume is multiplied by the Cut Swell Factor. Surface Target determines the Surface that the bottom of the trench is compared to, either: the Existing Surface, the Design, the Existing and Design to minimize cut, or simply to the Rim Elevations (no surface required). Trench Depths can be reported by either the bottom of the trench or bottom of the pipe by using the Depth Target pull-down. If you have Strata Surfaces defined then the program can calculate cut volumes for a strata you select. For more comprehensive reports you can customize, click on the Structure, Trench, and Depth Details Reports buttons. For the Standard Report, click the OK button.

**Setup Depth Zones** will report you your Trench depth zones by stations along the trench network. You can also color the trench in the drawing by defined zones. Click OK to compute the template volumes. Backfill quantities take into account pipe size. A report would be shown after the calculation.
Prompts

Trench Quantities Report Window
Draw zone map color legend on the screen [Yes/<No>]: \text{y for Yes}
Pick a point for color legend: \text{pick a point away from site}
Legend size <10.00>: \text{Press <Enter> for the default}

Prerequisite: Your drawing is open, has been cleaned up and pre-processed by such commands as Define Layer Target, Set Boundary Polyline, Make Existing Ground Surface and Make Design Surface. Trench structure data has been stored in a .sew file, whose name is as same as the drawing name.
Keyboard Command: calc_trench

Report Trench Network
This command will a report the Name, Station Distance, Invert-In Slope, Invert-Out Width, the Rim Elevation, Trench Type, Manhole Depth, and the Area Direction for the selected Trench. You may also choose to report the Trench Network from Downstream or Upstream, or just the Structures.
Prerequisite: a sewer line
Keyboard Command: reportswr

Roads Menu

Roads_Pull_Down
The Roads pull-down is a composite of commands taken from Carlson Civil. The pull-down includes centerline, vertical profile, cross-sectioning, and Road Network functions for estimating, plan view representation, and the
3D modeling of roads and highways. All of the commands for Roads are described in the manual under the Civil chapter.

**Sections_From_Polylines_On_Section_Grids**

Section From Polylines By Layer command can be used to automatically import section data from drawing entities by selecting samples of the different section elements. When running the command, you will first be prompted to name and save the section file you are about to create. The next dialog shown below will ask you to select the layers that represent different elements of the section. Use the mouse pick on the right side to pick the layer in the plan view, or type in the layer name in the middle column.

Here is an example of the linework needed for Section From Polylines.
The "Maximum grid text distance from grid" allows you to determine how far from the grid linework the routine searches in order to find text. The program uses the grid linework and the text associated with the linework to calculate the scale of the grid. Station Text Position tells the routine to assign stationing from text either Above or Below the section linework. After saying okay to this dialog, the routine will prompt you to select the entities to process. You can pick on linework, window around a group of linework or type in All.

**Pulldown Menu Location:** Roads > Create Sections  
**Prerequisite:** dwg with section grids  
**Keyboard Command:** sctfstc

## Display Menu

### Existing Drawing

This command allows you to display all the entities on the layers that are grouped as part of the Existing Drawing.

Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. When Existing Drawing is checked than the existing drawing will be displayed. If it is not checked it will
not be displayed. You can check on and off the other "Target" surfaces to view the existing drawing in isolation or in accordance to the other drawings.

**Keyboard Command:** set_display_exist_dwg  
**Prerequisite:** Define Layer Target/Material/Subgrade

---

**Existing Contours**

This command displays all the contours that represent the existing surface (For contouring options see Display Options). Clicking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

When Existing Contours is checked than all the contours for the existing surface will be displayed. If it is not checked they will not be displayed.

**Prerequisite:** existing surface  
**Keyboard Command:** set_display_exist_ctr

---

**Existing Surface**

This command allows you to display the surface triangulation for the existing drawing.
When Existing Surface is checked than all the triangulation for the existing will be displayed. If it is not checked, they will not be displayed.

**Keyboard Command:** set_display_exist_grd  
**Prerequisite:** an existing surface

### Design Drawing

This command allows you to display all the entities on the layers that are grouped as part of the Design Drawing.

Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. When Design Drawing is checked than the design drawing will be displayed. If it is not checked it will not be displayed. You can check on and off the other "Target" surfaces to view the Design drawing in isolation or in accordance to the other drawings.

**Keyboard Command:** set_display_final_dwg
Design Contours

This command displays all the contours that represents the design surface (For contouring options see Display Options). Clicking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

When Design Contours is checked than all the contours for the design will be displayed. If it is not checked they will not be displayed.

**Keyboard Command:** set_display_final_ctr

**Prerequisite:** design surface

Design Surface

This command allows you to display the surface triangulation for the design drawing.
When Design Surface is checked than all the triangulation for the design will be displayed. If it is not checked, they will not be displayed.

**Keyboard Command:** set_display_final_grd  
**Prerequisite:** a design surface

### Cut/Fill Contours

This command compares the existing and design surfaces and shows the cut/fill contours in blue for fill and red for cut. There is a Draw Only Cut/Fill Daylight option and Draw Labels option as part of the Display Options command (See Display Options for more information). Clicking on Cut/Fill Contours from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

**Keyboard Command:** set_display_cf_ctr  
**Prerequisite:** elevation differences between existing and design

### Cut/Fill Labels

This command displays the design elevation, the existing elevation, and the amount to either cut or fill right on the screen (See Display Options for information about labeling options). Picking on Cut/Fill Labels from the menu runs the command and puts a check mark on the menu. Picking again turns it off.
**Keyboard Command:** set display cf_txt  
**Prerequisite:** existing and design surfaces

### Cut/Fill Color Map
This command compares the existing and design surfaces and shows the cut/fill regions in blue for fill and red for cut (See Display Options for information on pixel resolution). Clicking on Cut/Fill Color Map from the menu runs the command and puts a check mark on the menu. Picking again turns it off.

**Keyboard Command:** set display cf_map  
**Prerequisite:** existing and design surfaces

### Other Drawing
This command allows you to display all the entities on the layers that are grouped as part of the Other drawing.
Carlson TakeOff allows you to assign layers into three different "Target" surface groups: Existing, Design, and Other. For more about assigning layers to different "Target" surface groups see Define Layer Target/Material/Subgrade under the tools menu. Once layers have been assigned, the display menu allows for easy viewing of each "Target" surface. Typically, most layers are listed under Other before they are assigned to Existing or Design. Some layers, like perimeter, are neither apart of the Existing or the Design drawing so they remain under Other. When Other Drawing is checked than the entities grouped under Other will be displayed. If it is not checked it will not be displayed. You can check on and off the other "Target" surfaces to view the Other surface in isolation or in accordance to the other surfaces. In this example, Existing, Design, and Other are all shown.

**Keyboard Command:** set_display_other_dwg

**Prerequisite:** Define Layer Target/Material/Subgrade

### Display Options

This command allows you to change the features of the different display commands. Note: You can toggle on/off the Existing, Design, and Other surfaces by right clicking with your mouse. To activate this feature type in "shortcutmenu" in the command line and then <1>. To turn off the feature type in <0>. 
**Display Setup:** Here is the master list for the major things you can display, including: the Entities, Contours, and Surface for both the Existing and Design, Cut/Fill Displays, and Other Drawing Entities.

**Contour Options:** Here you can set the interval, the elevation difference between each contour, for the Existing, Design and Cut/Fill by clicking on their Contour Settings. You can also choose to draw only the daylight line between Existing and Design instead of the Cut/Fill contours at an interval.
Draw Contours
When this box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

Contour by Interval or Contour an Elevation
Select whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

Contour Interval
Specify the interval to contour. Note: If the above option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

Minimum Contour Length
Contour lines whose total length is less than this value will not be drawn.

Reduce Vertices
This option attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is ON

Offset Distance
When the Reduce Vertices option is enabled, This value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

Hatch Zones
When activated, this option will allow you to hatch the area between the contours sequentially. A secondary dialog will load allowing the user to specify the hatch type and color.

Draw Index Contours
This option creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

**Contour Smoothing Method**

Select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

**Bezier Smoothing Factor**

The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect.

**Subdivisional Surfaces / Subdivisions Generation**

This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance's sake, consider enabling Reduce Vertices.

**Label Tab**

![Takeoff Contour](image_url)

**Label Contours**

When activated, contours will be labeled based on the settings below.

**Label Layer**
Specifies layer name for intermediate contour labels.

**Index Label Layer**
Specifies layer name for index contour labels.

**Label Style**
Specifies the text style that will be used for the contour label text.

**Label Text Size Scaler**
Specifies the size of the contour labels based on a multiplier of the horizontal scale.

**Min Length to Label**
Contours whose length is less than this value will not be labeled.

**Break Contours at Label**
When checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

**Draw Broken Segments**
When checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

**Label Contour Ends**
When checked, contour ends will be labeled.

**Draw Box Around Text**
When checked, a rectangle will be drawn around contour elevation labels.

**Label Index Contours Only**
When checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels**
This option activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour is fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels, and the contour lines themselves remain contiguous. This feature will also hide other entities that area in the immediate vicinity of the contour label.

**Align Text with Contour**
When checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

**Align Facing Uphill**
When checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the bottom of the text label will always be toward the downhill side of the contours. So as the labels are read right side up, you are always facing uphill.

**Internal Label Intervals**
Choose between label intervals or distance interval. Label intervals will label each contour with a set number of labels. Distance interval lets you specify a distance between labels.

**Cut/Fill Label Options:** Here you can customize the Cut/Fill labels. Text can be added either before or after the Cut/Fill amount, the Existing elevation, and the Design elevation with the Prefix and Suffix fields. You can also choose whether or not to display the Existing Surface elevations, the Design Surface elevations and Strata Cut Thickness. The colors for the Cut, Fill, Existing Elevation, and Design Elevation text are all customizable. Carlson TakeOff gives you the option to draw a marker symbol for where each label represents. You can also hide the drawing under the labels so that you can read the labels clearly. Text Size chooses the text size for each line of the label. Text Style allows you change the Font Style displayed in the labels. Decimal Places sets to how many decimal places the labels will report. The Spacing of the labels can be determined by intervals or by a selected number of spaces. The size of each space is determined by the Text Size.
Cut/Fill Color Map Options: Number Of Subdivision Rows is the number of blocks both horizontally and vertically in the Color Map. If the box reads 100 that means 100 blocks left to right and 100 blocks up and down or 10,000 total pixels. A higher the Number Of Subdivision Rows will make the Color Map sharper, however too high number can cause Carlson TakeOff to run slower. Auto Set Range will automatically set the red to blue scale for your cut/fill levels. However, if you desire greater contrast, then use Max Cut/Fill Range to manual set the range. Use lower numbers for greater contrast. There are several coloring schemes with different Cut-Daylight-Fill colors. For example, the Red-White-Blue scheme means red for cut, white for daylight and blue for fill.

Keyboard Command: tk_display_options
Prerequisite: a drawing
Field Module
COGO Menu

The most of the commands in the COGO pull-down menu are described in the Survey manual. Only the few commands that are specific to Field are described here.

### Tape Baseline

This command creates points or linework along a baseline that is defined by two points. After specifying the baseline start and end points by either entering point numbers from the coordinate file or screen picking points, the program has a dialog with different methods for creating the points. The Tape method creates points at the specified chainage (distance) and offset from the baseline. reports the cut or fill between your current position and a design surface. The design surface can be one flat elevation, a grid file, a triangulation file, a road design file, or a section file. The Rectangle method draws a rectangle as a closed polyline using two points specified by chainage and offset from the baseline. The Square method draws a square as a closed polyline with a starting point at a baseline endpoint and the other corner specified by a distance along the baseline. The Divide method creates points at an interval between the baseline endpoints.
Cutsheet Spreadsheet Editor

This command edits and reports cut sheet data that is stored in an Excel (.xls) file. To create this data with Field stakeout routines, the option to Store Cutsheet Data In Spreadsheet must be set active in Configure Field->Stakeout Settings.
Field Menu

The Field pull-down menu has the main functions for Field including equipment setup, storing points and stakeout.

Configure Field

This command sets the equipment type, communication parameters and other Carlson Field options. Make sure the Equipment Type box shows the correct GPS or Total Station equipment that you'll be using. The down triangle button to the right of this box brings up a list of the equipment types to choose from. There are ten Settings buttons to bring up the dialog boxes which are used to change Carlson Field's default settings. Explanations for each are shown below.
**General Settings**

If you are using a total station, *Rod Height* is the distance from the prism to the ground. For GPS, *Rod Height* is the distance from the center of the GPS antenna to the ground.

The *Show Carlson Field Startup Icon* controls whether the Carlson Field Startup Icon is displayed in the lower right of the screen. This startup icon brings up the Carlson Field function menu for launching Carlson Field commands without having to pick them from the pull-down menu.

The *Twist Screen In Direction Of Movement* will rotate the drawing view so that your current direction of movement is facing straight up in the view. This rotate is for the view only and does not change the coordinates. This option only applies to GPS and robotic total stations in commands that show the arrow icon such as Track Position.

The *Display Feet and Inches for Total Stations* will use a feet and inches display format (1'2 3/4") in most routines when using a total station.

The *Adjust Dialog Font Size For Resolution* will attempt to adjust some dialogs to better fit the resolution you are using.

The *Use Bold Font* toggles between using standard or bold font for the Carlson Field dialogs.

The *Station Type* chooses the format of centerline station labels. Typically 1+00 is used for feet units, 1+000 is used for metric and 100 has no plus symbol in the number.
GPS Settings

The RMS Tolerance checks the RMS values when reading GPS positions. The RMS is the accuracy value reported by the GPS receiver. There are separate settings for the horizontal and vertical RMS values. The RMS (root mean square) value means that the reported coordinate is within +/- the RMS value of the true coordinate to a certain confidence level. The confidence level depends on the GPS receiver. Typically it is a 98% confidence. If either RMS value exceeds the user-defined tolerance while storing points, Carlson Field will default to "No" when it asks if you want to store the point. You are required to choose yes to override the tolerance check and store the point.

Suggestion: When GPS RTK systems lose lock and go "Float", both the horizontal and vertical RMS values typically jump up to sub-meter (1' or higher) values. In Carlson Field, one foot is the default for the GPS RMS Tolerance. Some operators set the GPS RMS Tolerance low to 0.2 to check for high RMS values while still "Fixed".

Store Locked Only - The position of the GPS rover is considered either "Autonomous", "Float" or "Fixed" based on the solution status from the GPS base corrections. When you are storing points and the Store Locked Only box is checked, Carlson Field will only store points if your position is "Fixed". We suggest you leave this box checked. It ensures that you do not record inaccurate points.
Suggestion: When walking in light to heavy canopy, the rover might remain "Float" and display RMS accuracies of over a foot, sub-meter or more. Setting your GPS RMS Tolerance high and turning off Store Fixed Only will allow storing wetland and LOD (limits of disturbance) points under canopy that require only sub-meter tolerances. (USCG beacon DGPS sub-meter RTK GPS will always use these settings.)

Projection Type - defines the datum coordinate system to be used for converting the latitude/longitude from the GPS receiver into cartesian coordinates. For the United States two separate horizontal control systems have been developed by the Federal Government: State Plane 1927 and State Plane 1983. For international use the UTM (Universal Transverse and Mercator System) should be selected. The Lat/Lon option will convert the latitude/longitude from degrees minutes seconds format into decimal degrees. This option is useful when working in a decimal degrees lat/lon coordinate system.

Zone - For State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

Important: Coordinates of surveyed points will be inaccurate if the Projection Type and Zone settings are wrong. If you have done survey work and then realize that they are set wrong, then your point coordinates are wrong, but your work is not wasted. Carlson Field records the latitude, longitude and height of every point in a *.RW5 file. You can input the correct projection zone settings later and reprocess your data using the Edit-Process Raw File command.

Model - For UTM, this option sets the ellipsoid constants for converting the lat/lon to UTM coordinates. The following is a list of the models:

Model Earth Radius(m) Flattening factor
Airy 1830 6377563.396 0.00334085064038
Modified Airy 6377340.189 0.00334085064038
Bessel 1841 6377397.155 0.00334277318217
Clarke 1866 ellipsoid 6378206.4 0.00339007530409
Clarke 1880 6378249.145 0.00340756137870
Everest(EA-India 1830) 6377276.345 0.00332444929666
Everest(EB - Brunei & E.Malaysia) 6377298.556 0.00332444929666
Everest(ED - W.Malaysia & Singapore) 6377304.063 0.00332444929666
Transformation - The transformation in the Align Local Coordinates command can either be by plane similarity or rigid body methods. Both methods use a best-fit least squares transformation. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale. The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates.

One Pt Align Azimuth - This option applies to the rotation when using one point in Align Local Coordinates. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

Two Point Align Method - This option applies only two point alignments. Possible values are Fit & Rotate and Rotate Only. Fit & Rotate (the default) will use the second alignment point for rotation, translation, and scale (depending on the value set for Transformation). The Rotate Only option will use the second point of a two point alignment for rotation only.

Geoid To Apply - This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the National Geodetic Survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (Eo), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This correction is the geoid undulation (Ug). The formula is He=Eo + Ug.

The Geoid models are essentially large elevation difference models in grid format. Carlson Field has two geoid models available. Geoid99 covers the United States at 1 minute grid intervals. EGM96 covers the entire globe at 15 minute intervals. These Geoid models are huge and take a lot of disk space and memory. The Geoid model files are not installed automatically and instead need to be installed by going to the Geoid folder on the Carlson Field installation CD. Once installed onto Carlson Field, you then need to specify your location by lat/lon so that the program only needs to load a local portion of the Geoid model. To set your local Geoid area, pick the Set Geoid Area button. Setting the Geoid area will carve out a Geoid model around the specified lat/lon covering a square area of 2 degrees by 2 degrees which is about 100 miles by 100 miles.

Carlson Field applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In the Monitor function, the Geoid undulation is displayed.

In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a known point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson Field can model the elevation difference which can generally pick up the local Geoid undulation.

Project Scale Factor - After converting the LAT/LONG from the GPS to the state plane coordinates and applying the Align Local Coordinates, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X,Y and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in Align Local Coordinates. If there are no points specified in Align Local Coordinates, then 0,0 is used as base point. The Project Scale Factor can be entered directly or calculated using the grid factor and elevation for the current position. When using the current position, the program will read the LAT/LONG from the GPS receiver. The scale
factor is then calculated as: (State Plane Grid Factor - (Elevation/Earth Radius)).

**Default Alignment** - This option sets the alignment file to use by default for new drawings. This feature applies when you will keep working at the same site with the same base receiver setup.

**Helmert 7-Parameter Transformation** - These settings apply when the Transformation is set to Helmert. The Helmert 7-parameters can either be calculated by the program using the control points in the localization or user-entered.

**Laser Offset Settings** - There is an option to use a laser for reading the distance and angle for offset points. When this option is enabled, you can choose the laser equipment type and communication parameters. The serial port for the laser must be different than the GPS which requires at least two serial ports on the computer. When using a laser for offsets, the program will read the current position from the GPS and then read the laser for the distance and angle to the point. This combination allows you to calculate points that cannot be directly reached by the GPS. There are two methods in the Point Store command to use the laser when this option is enabled. The Point Store dialog will have a new Laser button which will bring up another dialog that allows you to take multiple shots from the laser. The other method is to click on the Offset toggle in the Point Store dialog. Then when you do the Read function, the program will read the GPS position and then pop-up a dialog for taking one offset shot.

**Point Settings**

**Beep for Store Point** - This option will make a triple beep to indicate when a point is stored in the coordinate file.

**User-Entered Point Notes** - Point Notes are additional descriptions that can be stored with a point. A regular point consists of a point number, northing, easting, elevation and 32 character description. These points are stored in a .CRD file. Point Notes are a way to add an unlimited number of lines of text to a point number. With Point Notes ON in the Store Point command, the program will prompt for notes after collecting a point. The notes are stored in a file that uses the name of the coordinate file with a .NOT extension. For example, a coordinate file called JOB5.CRD would have a note file called JOB5.NOT.
Coordinates in Point Notes - When storing a point, this option will store the point number, northing, easting, elevation and description in the point notes as well. This may be used as a backup or reference to coordinate data as it was originally stored.

GPS RMS in Point Notes - When storing a point, this option will store the horizontal and vertical RMS values in the note field for the point. This offers a good check on the quality of the shot.

GPS DOPs in Point Notes - When storing a point, this option will store the DOP (dilution of precision) values as reported from the GPS receiver.

Rod Height in Point Notes - When storing a point, this option will store the rod height value in the note field for the point.

Project Scaler in Point Notes - When storing a point, this option will store the project scale factor in the note field for the point.

Time/Date in Point Notes - This option will store the time and date that the point was stored in the note file. Carlson Field will read the time from the computer.

Drawing Options control how points are drawn by default. It controls the layer, symbol number and whether points will be drawn with descriptions and elevations. Carlson Field's Field to Finish code table can override these defaults.

The symbol used for default points is displayed. You can choose another symbol by changing the Symbol name or by selecting one from the table that the Select Symbol button brings up. Default point settings are used for points whose descriptions don't correspond to any category on the Field to Finish code table.

Label Descriptions and Label Elevations Control whether these two items of information appear on your drawing next to each point.

Locate on Real Z Axis will record points with their true elevations. If this setting is off, all points recorded will have an elevation of zero.

Layer for Points indicates the layer where all default points will be drawn. For points using a code on the code table, the code table will determine their layer.

Number of Readings specifies how many times Carlson Field will read from the instrument in the Read function of the Point Store command. This applies to both GPS and total stations. The readings will be averaged to find a more accurate position.

Direct-Reverse Tolerances are used with total stations to check the pairs of direct and reverse horizontal angles, vertical angles and distances. When these values are off by more than the tolerance, the program will display a warning.

Field to Finish is explained fully in the Field to Finish command definition. Basically it uses a code table which holds information on types of points (ie. Man Hole or Edge of Pavement). When the settings Use Code Table...For Symbols, For Layers and For Descriptions are selected, Carlson Field will look to the code table for how to draw points of a particular code description.

The file containing the active code table appears after Code File: You can change this with the button Select File.

The Split Multiple Codes option will draw multiple points from the same point when that point description has multiple codes. For example, a point with description "EP DR" will draw the point twice: once with the properties of code EP and a second time using code DR. When this option is off, the program will use the first code and draw the point once.

The Check Descriptions With Code Table option will display a warning before storing a point if that point description is not found in the code table. With this option off, the program will go ahead and store the point and the point will be drawn using the default point properties.

Stakeout Settings

Display GPS RMS in Stakeout causes Carlson Field to report the constantly updating horizontal RMS accuracy values while staking a point. The only disadvantage to having this option active is that it slows down a little the stakeout position update.
Draw Trail displays a line in the stakeout screen showing where you've been as you move towards the stakeout point. This option only applies to GPS.

Prompt For Snap On Screen Pick controls whether you are prompted to select an object snap when picking points from the screen during stakeout.

Auto Zoom will zoom the drawing display in or out so that both your current position and stakeout target are visible on the screen.

Zero Horizontal Angle To Target will set the horizontal angle of the total station to zero in the direction towards the stakeout point. When stakeout is completed, the horizontal angle is set back to the original value. This option only applies to total stations.

Automatic Turn To Point Type For Robotic Total Stations does two things. First, it controls whether or not stakeout automatically turns to the stakeout point. Second, it allows the user to select what type of turn is performed: Horizontal Angle only, or Horizontal and Vertical Angle.

Default Stakeout Mode allows the user to select a default stakeout mode to be used when entering the stakeout routine. Choices include the stakeout modes: Station-Offset, Point Number, and Pick Point. If Pick Point is selected as the default stakeout mode, the user can also define the default object snaps.

Store Cutsheet/Stakeout Data in Note File will store stakeout data in the note file (.NOT) for the current coordinate file. At the end of staking out a point, there is an option to store the staked coordinates in the current coordinate file. This stakeout note file option allows you to store more stakeout data in addition to the staked coordinates. This additional data includes the target coordinates and horizontal and vertical difference between the staked and target points. This stakeout note data can be used in reports with the List Points or CutSheet Report commands.

Store Cutsheet/Stakeout Data in Excel Spreadsheet will display a cutsheet report in an Excel spreadsheet. The spreadsheet will pop-up at the end of each point stakeout. The report can be saved in Excel format and processed by Excel.

Store Stakeout Points To Separate Coordinate File will store the staked points to a different coordinate file besides the current coordinate file. This allows you to use the same point number for the target and staked points. The staked point coordinate file can be specified by picking the Select Coordinate File button.

Check Total Station Turn Angle will compare the angle from the instrument and the angle to the target point. If this difference is greater than the specified tolerance, then Carlson Field will display a warning message.

Stakeout Tolerance controls the maximum difference between the target location and actual staked point. When the staked point is beyond the tolerance, Carlson Field displays a warning dialog.
GPS Number of Reads for Final Average specifies how many times Carlson Field will read the GPS receiver position for the final staked point. These reading are averaged. Averaging several readings while occupying one point yields a more accurate result, but inevitably takes longer.

Total Station Scale Settings

These settings apply only to total stations. The Project Scale Factor is multiplied by the measured distance from the total station when calculating the foresight point coordinates. A typical project scale factor for working in state plane coordinates is slightly less than one. Factors greater than 2.0 or less than 0.5 are not allowed. The Project Scale Factor can be entered directly or choose the Calculate button. The Calculate function takes a state plane coordinate and calculates the project scale factor as the state plane grid factor minus the elevation factor (Grid Factor - elevation/earth radius). The state plane coordinate is specified by a point number from the current coordinate file.

The Calculate State Plane Scale Factor At Each Setup option will calculate the scale factor for each shot as the combined grid and elevation factors (see above equation). The scale factor is calculated at both the occupied and foresight points and then averaged. To use this option, you must be working in state plane coordinates and set the state plane zone in this dialog.

The Correct For Earth Curvature option adjusts the horizontal distance and vertical difference to the foresight point to account for the earth curvature.

Prism Offset is for use with total stations to account for the offset (in mm) of the prism in use. It is recommended to keep this at zero, and set the prism offset in the instrument.
Depth Sounder Settings
Carlson Field can use depth sounders in combination with GPS to collect points of underwater surfaces. Carlson Field supports depth sounders that output standard NMEA data. There are several models to choose from: Hydrotrak, Horizon, Odom Digitrace, InnerSpace, and Generic. For the Odom Digitrace and InnerSpace models, you also need to specify the depth unit mode that the instrument is set to.

The *Store Depth In Notes* option will record the water depth in the current note file (.NOT) when a point is stored to the coordinate file.

The *Debug* toggle can be used when contacting technical support to diagnose communications issues between the depth sounder and Carlson Field.

The depth sounder must be connected to a separate serial port than the GPS. The *Baud Rate* between the computer serial port and the depth sounder is also specified here.

Elevation Difference Settings
These setting apply to the Elevation Difference command. Grading Tolerance is the target difference between the actual elevation and the design surface. Carlson Field can use an external Light Bar to indicate whether your current position is in cut, fill or on-grade. Currently Carlson Field supports light bars made by Apache and Mikrofyn. The Light Bar must be connected to a separate serial port than the GPS.
GIS Settings

A standard point is stored in the coordinate file with a maximum 32 character description. The GIS Settings allow you to store more data with each point.

The **Store Data In Note File** option will record additional fields for each point in the note file. The note file has the same name as the current coordinate file except with a .NOT instead of .CRD file extension. The fields that are recorded are defined by the GIS File (.GIS). This file defines a sequence of field names and prompts. For example, a GIS file for manholes could contain Location, Depth and Condition fields. Choose the Select File button to choose the GIS file to use. Or use the **Select GIS File Automatically by Point Description** to use different GIS files depending on the point description. With this option, the program will look for a GIS file with the same name as the point description. For example, if the point description is MH, then the GIS file will be MH.GIS. See the Define Note File Prompts command for more information.

The **Store Data Direct To Database** option will store additional fields for each point in a Microsoft Access database. The database to store the data is set in the Output File line. The Template File is a database that defines the fields to record. See the Define Template Database command for more information.

Centerline Position Settings

Similar to Elevation Difference Settings only for the Centerline Position command.
Communication Port Settings

*Serial COM Port* - The GPS receiver or total station attaches to your Carlson Field computer using a serial cable. This cable is plugged into a serial COM port on your computer called 1, 2, 3 or 4. Check the circle denoting the COM Port to be used.

The *Baud Rate, Parity, Char Length* and *Stop Bits* are the serial port communication parameters for the Carlson Field computer. These parameters need to match the parameters on the instrument that you are using. The Defaults button will set these communication parameters to the standard parameters for the current equipment type.

Equipment Type

The *Equipment Type* droplist allows the user to select the instrument driver to use. The very last entry is for "Library Drivers" which are instrument drivers that follow a new Carlson architecture and support many advanced features (ex. NTRIP). These "Library Drivers" are different from the legacy Carlson Field instrument drivers; they are shared with other Carlson products (ie. SurvCE and Carlson Grade). To select a "Library Driver", select that item and press the *Edit* button. Please note, that the *Edit* button is only active for "Library Drivers".
Selection of a "Library Driver" is split into two types: Base and Rover. After selecting the Driver Type, select the proper manufacturer and model to match the equipment being used.

Carlson Field also allows the user to save and recall equipment configurations. If you use the same equipment in different configurations, saving the configuration is an easy way to recall it later without missing a setting. First, select the Equipment Type you wish to save a configuration for. Next, make sure all the instrument settings are as desired by running through Equipment Setup. Finally, press the Save button and enter a description configuration name that will help remind you what the configuration is used for. Keep in mind, saving a configuration will also save the current GPS Settings (ie. projection type, etc).

To recall a saved configuration, just select the configuration and press the Load button.
Equipment Setup

Function with Total Stations

Selecting the Equipment Setup command will send the user directly to a settings window that corresponds with the instrument selected in Configure Field. Equipment Setup for total stations will be discussed first, followed by GPS equipment.

This function for Total Stations lets you tell Carlson Field how you have positioned your total station. The setup information in this command is required before taking shots. Besides running this command from the Field pull-down menu, you can also reach this command with the Setup(F3) button from many of the other Carlson Field functions.

*Occupied Point* refers to the point your total station is setup on. This point is defined by a point number that references the current coordinate file. The coordinates and description of this point are displayed below the point number. The *List* button will bring up a list of the points in the coordinate file which you can review or select from. If the coordinates for the occupied point are not yet in the coordinate file, then you can pick the *Create Point* button to enter these coordinates.

The backsight can reference either a point or an azimuth. *Backsight Point* is only used if *Point Number* is selected as your *Backsight Method*. If you want to use an azimuth instead of a backsight point, select the *Azimuth* toggle and specify the azimuth in the *Bksight Azi* box.

Set the *Instrument Height* and *Rod Height*. These values will use whatever units your drawing uses: feet or meters. Carlson Field expects the instrument to have the horizontal angle zeroed on the backsight. Part of the station setup procedure needs to include zeroing the instrument on the backsight. To do this, first specify the occupy point and backsight in this dialog. Then orient the instrument to the backsight and pick *Zero Hz* to zero the gun.
The BS Check button runs a backsight check. The program will take a shot and compare the calculated point to the expected backsight point and report the results to you. This will help you establish if the point you are using as the backsight point is really the point that you think it is. For some robotic total stations, the Backsight Check routine has an option to automatically turn the instrument to the backsight. Then after the check is done, the instrument can be automatically turned back to the previous direction. The purpose of this auto turn is to speed up the steps to check the backsight in the middle of surveying points in a different direction.

For some types of total stations, the Total Station Setup dialog will also contain different options that are specific to that type of total station.

**Geodimeter Total Station Setup**

The three methods of connecting to the Geodimeter include: Station, RPU and GeoRadio. The Station option is for connecting directly to the instrument. The RPU is a remote control panel. The GeoRadio is a radio for remote control of the instrument. For the GeoRadio, the Station Address and Remote Address set the radio addresses and the Radio Channel sets the radio channel.

The intensity of the instrument Tracklight can be set to Off, Low or High.
The Geodimeter *On* and *Off* buttons are for putting the instrument in sleep mode to save power.

There are four different read methods. STD mode has a 3.5 second measurement time for each point. It is usually used when a normal degree of angle and distance accuracy is required. TRK mode uses automatic, measured values that are updated 0.4 seconds after making a contact with the prism. Rep STD mode measures distance automatically every 4 seconds. Fast STD mode measures distance in 1.3 seconds. It is used when the demands on precision are low.

**Leica Total Station Setup**

The *Connection Mode* chooses between connecting Carlson Field directly to the instrument or to a radio for remote control.

The *EDM Mode* sets the instrument distance measurement mode for standard shots. All the possible modes are listed in this dialog including tracking and reflectorless. Be sure to choose a mode that is supported by your instrument. When using the reflectorless mode, the Rod Height should typically be set to zero. When tracking is selected in Carlson Field functions, the program will automatically put the instrument in IR Rapid Tracking mode during tracking and then return to the specified EDM Mode when tracking is done.

The intensity of the instrument *Tracklight* can be set to Off, Low, Medium or High.

*Laser Pointer* allows the user to toggle the instrument's laser pointer on and off, if the instrument is so equipped.

*ATR (Auto Target Recognition)* allows the user to choose whether or not to use the instrument's ATR system, if the instrument is so equipped. This option is not available when using a reflectorless EDM mode.

Use *Instrument Series* to select the proper Leica TPS model you are using. There are only two choices: 1200 (which uses the GeoCOM protocol) or 100/300/400/700/800/1000/1100 (which uses the GSI protocol).

The *Robotics* button can be used to access the joystick screen, where the user can access convenient controls for robotic total stations.

![Total Station Setup dialog](image)

The older Leica total station driver allows the user to select what type of keyboard emulation to use, 1 or 2 row.
Topcon 800A/8000 Direct Total Station Setup

The Read Method sets the instrument distance measurement mode for standard shots. When tracking is selected in Carlson Field functions, the program will automatically put the instrument in Coarse mode during tracking and then return to the specified EDM Mode when tracking is done.

Topcon 800A/8000 Remote Total Station Setup

The Radio Type can either be Satel 3AS, Satel 2AS, RC-2, Stream, or Other. With Other, Carlson Field does not send any radio setup commands. So these radios must be configured before running Carlson Field. For the Satel 3AS radios, you can set the radio frequency by Channel ID or by manually typing a frequency between 468.5 and 470.5. Stream can be used in any situation where Other would be used. However, Stream is different in that the instrument streams measurements to Carlson Field thereby decreasing the probability of a failed reading. It should be noted, if Stream is used over a very poor radio connection, it is possible for Carlson Field to get out of sync with the instrument and fail to stop streaming when needed.

The EDM Mode sets the instrument distance measurement mode for standard shots. When tracking is selected in Carlson Field functions, the program will automatically put the instrument in Coarse mode during tracking and then return to the specified EDM Mode when tracking is done.

Wait Time is switched on when the instrument cannot track a prism due to an obstruction. If after the wait time have elapsed the instrument does not switch back to tracking mode, then searching mode is set.
Vertical range and Horizontal range set the search area. Vertical range can be anywhere from 0-90 degrees, and horizontal range can be anywhere from 0-180 degrees.

Track Indicator On if checked turns on the light which is mounted below the telescope.

Joystick Speed sets the instrument turning speed from the arrow keys in Robotic control.

Topcon APL1/APL1A Total Station Setup

The Radio Type can either be Satel 3AS, Satel 2AS or Other. With Other, Carlson Field does not send any radio setup commands. So these radios must be configured before running Carlson Field. For the Satel 3AS radios, you can set the radio frequency by Channel ID or by manually typing a frequency between 468.5 and 470.5.

The EDM Mode sets the instrument distance measurement mode for standard shots. When tracking is selected in Carlson Field functions, the program will automatically put the instrument in Coarse mode during tracking and then return to the specified EDM Mode when tracking is done.

Wait Time is switched on when the instrument cannot track a prism due to an obstruction. If after the wait time have elapsed the instrument does not switch back to tracking mode, then searching mode is set.

Vertical range and Horizontal range set the search area. Vertical range can be anywhere from 0-90 degrees, and horizontal range can be anywhere from 0-180 degrees.

Track Indicator On if checked turns on the light which is mounted below the telescope.

Joystick Speed sets the instrument turning speed from the arrow keys in Robotic control.
Zeiss20 Total Station Setup

The *Connection Mode* chooses between connecting Carlson Field directly to the instrument (cable) or to a radio for remote control.

Equipment Setup with GPS

Carlson Field works with the following RTK GPS manufacturers: Ashtech, Javad, Leica, Novatel, Sokkia and Trimble. Each RTK GPS brand has its own GPS Setup control window. To get the window which matches the GPS equipment you are using, go to Configure Field and under the Equipment Type pulldown menu select the correct equipment. A brief explanation is given below for each brand's controls.

For RTK (real-time kinematic) GPS work, the base sends GPS corrections to the rover. To setup a base receiver, you should attach the computer running Carlson Field to the base receiver and run the Equipment Setup. After this is done and the base is outputting corrections, you should detach the base receiver and attach the rover receiver and do Equipment Setup again.
If your base radio has a TX light, it should be flashing while it's sending out corrections. This is a convenient way to tell if the base is configured.

**Ashtech GPS Setup**

The *Ashtech Type* specifies the model of Ashtech equipment to be used. Carlson Field works with the following Ashtech high precision, centimeter accurate RTK GPS equipment: Z12, Z-Surveyor/Sensor, GG24, Z-Extreme, and Z-Max. Carlson Field also works with the Ashtech Reliance USCG/DGPS RTCM sub-meter RTK GPS receivers.

The previous Ashtech Control settings are default. Changing these settings will change the internal settings of the Ashtech receiver.

**Ashtech Data Port** is the port on the GPS receiver where the Carlson Field computer is connected, usually Port A.

**Ashtech Radio Port** is the port on the receiver where the radio modem is connected, usually Port B. For the Z-Extreme, Port D is usually used for the radio port.

**Message Type** for high precision centimeter RTK GPS set message type to Ashtech (CPD). If you are using the USCG/RTCM DGPS message type for sub-meter accuracy then set the message type to RTCM (USCG).

**Multipath Type** is used to filter out interference in the satellite signals caused by nearby objects. The choices are No Multipath, Low: Open Field, Medium: Default, High: Building and Severe: Forest, Urban.

**Dynamics** settings are Static, Quasistatic, Walking and Automobile. Static is selected only when the Rover receiver is stationary. The default is Walking.

**Elevation Mask** is the cutoff vertical angle above the horizon. Any satellites below this angle will be left out of calculations.

**Site Name** and **Record Interval** are all setting for post processing use only, not for use with RTK GPS. Site Name is the Point ID name for post processing. Record Interval is the epoch interval to record post processing information. RTK GPS updates every second but post processing epochs are usually 5, 10, 15, 20 or 30 second intervals.

**Ambiguity Fixing Parameter (90 - 99.9):** controls the confidence level of fixed positions. The default is 99.0. At a lower confidence interval the system solves much faster. If the system incorrectly solves the position, then the position error will be much greater than the reported RMS value.
**Position Update Rate** is the frequency that GPS positions are calculated and reported.

**Fast CPD** is a toggle On or Off. Fast CPD toggled On will allow approximating the rover’s position if your position is lost briefly. Off is the default. Fast CPD is generally toggled on when Dynamics is set to Automobile.

When Carlson Field functions start, the program uses the settings specified in Equipment Setup to configure the GPS receiver. The *Save Settings to Receiver* uploads the settings in the Carlson Field dialog to the receiver so that the next time the receiver is turned on these settings are still set even without connecting to Carlson Field. Otherwise, Carlson Field must be connected to the receiver to setup these options.

**Send Command to Receiver** allows experienced users to type in commands using Ashtech GPS receiver commands to set or report internal settings. (See the Ashtech operations manuals for a complete list of Ashtech GPS receiver commands.)

**Reset Sensor Memory** will reset the receiver memory, reinitialize the communications ports and reset the modem. Saved settings on the receiver will be returned to their default values.

**Radio Baud Rate** allows you to change Pacific Crest radio baud settings through the receiver. The default baud rate is 9600. (Note: If there are communication problems with either port A or B on the Ashtech ZSurveyor receiver, turn off receiver and turn it back on with both keys depressed to reset receiver to factory defaults.)

For the Z-Extreme, the *Configure Internal Radio* button allows you to change the radio channel and settings. This function will attempt to establish a connection with the internal radio, reporting an error if it is unable to do so. Otherwise, it will open a dialog which will display the current radio channel as well as the valid range of radio channels. Enter the desired radio channel in the edit box and then click on "Program Radio" to set the changes to the radio. Carlson Field will communicate with the radio for a few seconds, and will then request that you power the receiver down, then turn it on again before continuing. It is very important that this is done, or else Carlson Field will be unable to communicate with the ZExtreme. Also note that if the programming of the radio is canceled for any reason, the receiver will still need to be powered down, then powered up again in order for Carlson Field to be able to communicate with it.

**Create Base REF File** takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

**Configure Base Station** initiates the receiver connected to Carlson Field to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

**Topcon GNSS/Javad GPS Setup**

**Radio Port** on the Javad base and rover receiver is usually C. Data Port is always A. When using Pacific Crest radios, Javad recommends the new PDL Pacific Crest radios. These must be set to 38,400 baud rate. Javad also uses Spread Spectrum radios which work at 119,200 baud rate.

**Receiver Model** selects between *Legacy*, *Odyssey* and *Regency*. Currently the Receiver Model does not effect the Carlson Field interface except to determine the default Antenna Type.

**Position Update Rate** sets the frequency that the receiver calculates and reports position. The faster rates are an option that must be purchased for the receiver.

**Antenna Type** chooses between an internal and external GPS antennas. This option applies to receivers with built-in antennas.

The **RTK Message Type** determines the format of the GPS correction message that is used from the base to the rover. **RTK Calculation Mode** chooses between Delay and Extrapolate. The Extrapolate mode is needed for fast Position Update Rates.

**Satellite Elevation Cutoff** is the cutoff vertical angle above the horizon. Any satellites below this angle will be left out of calculations.
**Ambiguity Fixing Parameter (95 - 99.9):** controls the confidence level of fixed positions. The default is 99.0. At a lower confidence interval the system solves much faster. If the system incorrectly solves the position, then the position error will be much greater than the reported RMS value.

**Power Cycle Receiver** is the same as turning the Javad receiver off and then on.

**Restore Factory Defaults** resets the Javad receiver to factory settings the receiver stops acting as base or rover. The baud rate of Port A will be set to 115,200. Reset this to 9600 by turning the receiver off and then on while holding down the FN button. Watch the REC light go from orange to green to red and then let up the FN button. This method can be used if Carlson Field cannot establish communications at any time.

**Clear Non-Volatile Memory** does everything Restore Factory Defaults does and also wipes out the almanac data that tells it where to look for the satellites. The receiver then downloads a new almanac from the satellites.

**Send Command to Receiver** allows experienced users to type in commands using Javad GPS receiver commands to set or report internal settings. (See the Javad operations manuals for a complete list of Javad GPS receiver commands.)

**Create Base REF File** takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

**Configure Base Station** initiates the receiver attached to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

**Leica GPS Setup**

Carlson Field works with the following Leica GPS receivers: System 500, GS50, MC1000 and MK31. The type of Leica receiver is set in the Configure Field command. The options available in the GPS Setup dialog depend on the current type of receiver.

**Leica Radio Port** is the port on the receiver where the radio is attached, usually 2 or 3. Port 1 is usually the one attached to the computer. For the System 500 receivers, you can also set the radio baud rate, stop bits and parity parameters.
For the system 500 receivers, you need to specify the antenna types used at both the base and rover receivers. This antenna type sets the phase center offsets for the antennas which can affect the reported elevations by as much as 0.25 foot if not set properly.
Cell phones can also be used with Leica GPS equipment instead of radios for RTK work.

For GS50 receivers, you can choose between US Coast Guard or Racal for the corrections.

**Power Cycle Receiver** shuts the receiver off and turns it back on. This forces the receiver to reinitialize tracking satellites and the position solution. This routine is useful if the receiver is stuck in float solution.

**Send Command to Receiver** allows experienced users to type in Leica commands or send a file to set or report internal settings. (See the Leica operations manuals for a complete list of Leica GPS receiver commands.)

**Create Base REF File** takes a reading from the GPS receiver and stores this lat/lon to a reference file (.ref) that can be used later in Configure Base Station. The purpose is to allow moving the base station based on the current base setup. In this case, Create Base REF File would be run from the rover receiver while in "fixed" position. Then the base could be moved to this point without having to redo the local coordinate alignment.

**Configure Rover** sets the receiver to rover mode.

**Configure Base Station** initiates the receiver attached to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)
Navcom GPS Setup

Novatellite GPS Setup

Carlson Field works with the original Novatel Outriders and the just released Outrider DL's including the centimeter accurate RT-2 RTK receivers and the sub-meter accurate Gismo USCG/satellite RTCM/DGPS beacon receivers.

Radio Port for external radio connection is typically COM 2 on the receiver. The Data Port connected to Carlson Field is typically COM 1.

Differential Mode toggles the Novatel GPS receiver to use RTCA, RTCM or CMR message types. RTCA is proprietary to Novatel and is used only for centimeter accuracy RTK GPS surveying. RTCM can be used with USCG/DGPS beacon signals for sub-meter accuracy. Novatel receivers work with Trimble CMR proprietary message signal type and can be either a base or rover working with Trimble RTK GPS receivers.

Dynamics toggles the rover between Kinematic or Static. The base is always in Kinematic mode. Kinematic is used for surveying while walking with the receiver. Static is for stationary use only at the rover and gives better accuracies. Since Static mode is for more precise measurements, it can be used for GPS alignment points and for any control points. The receiver should not be moved while in Static mode.

Elevation Cutoff is the vertical cut-off angle above the horizon. Any satellites below this limit will be ignored in calculations. 15 is a common setting.

Elevation Type chooses between Mean Sea Level or Ellipsoid for the elevation model used by the receiver.

Solution Reset (Soft Reboot) resets the Novatel receiver in a few seconds. This is used when the rover receiver is locked up or not properly reporting its position in the Monitor function.

Receiver Reset (Full Initialize) essentially does a factory reset and a power off and on cycle.

Chapter 10. Field Module
A Receiver Reset (Full Initialize) takes three to five minutes to get back on line and become fixed after a full initialize.

*Set Radio Channel* allows you to change Pacific Crest radio channels through the receiver. The base and rover must operate using the same radio channel.

*Send Command to Receiver* allows experienced users to type in commands using Novatel GPS receiver commands to set or report internal settings. (See the Novatel operations manuals for a complete list of Novatel GPS receiver commands.)

*Check Communication Status* checks the radio port operation and reports the status as working or not communicating.

*Configure Base Station* initiates the receiver connected to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

**Sokkia Radian GPS Setup**

*Radio Port* for external radio connection is typically COM 2 on the receiver. The Data Port connected to Carlson Field is typically COM 1.

*Differential Mode* toggles the Sokkia GPS receiver to use RTCA, RTCM or CMR message types. RTCA is proprietary to Sokkia and is used only for centimeter accuracy RTK GPS surveying. RTCM can be used with USCG/DGPS beacon signals for sub-meter accuracy. Sokkia receivers work with Trimble CMR proprietary message signal type and can be either a base or rover working with Trimble RTK GPS receivers.
**Dynamics** toggles the rover between Kinematic or Static. The base is always in Kinematic mode. Kinematic is used for surveying while walking with the receiver. Static is for stationary use only at the rover and gives better accuracies. Since Static mode is for more precise measurements, it can be used for GPS alignment points and for any control points. The receiver should not be moved while in Static mode.

**Elevation Cutoff** is the vertical cut-off angle above the horizon. Any satellites below this limit will be ignored in calculations. 15 is a common setting.

**Solution Reset (Soft Reboot)** resets the Novatel receiver in a few seconds. This is used when the rover receiver is locked up or not properly reporting its position in the Monitor function.

**Receiver Reset (Full Initialize)** essentially does a factory reset and a power off and on cycle. A Receiver Reset (Full Initialize) takes three to five minutes to get back on line and become fixed after a full initialize.

**Set Radio Channel** allows you to change Pacific Crest radio channels through the receiver. The base and rover must operate using the same radio channel.

**Send Command to Receiver** allows experienced users to type in commands using Sokkia GPS receiver commands.
to set or report internal settings. (See the Sokkia operations manuals for a complete list of Sokkia GPS receiver commands.)

*Check Communication Status* checks the radio port operation and reports the status as working or not communicating.

*Configure Base Station* initiates the receiver connected to be a base and begin broadcasting its stationary position and satellite corrections to the rover. (See Configure Base Station for All GPS Brands at end of this section.)

**Trimble GPS Controls**

Carlson Field works with the following Trimble receivers: 4000 series, 4700, 4800, 7400, NT300D, GeoExplorer and Pathfinder. The type of receiver is set in the Configure Field command. The options available in the GPS Setup dialog depend on the current type of receiver.

For the Pathfinder and GeoExplorer, the *Altitude Measurement Type* chooses between using Ellipsoid or Mean Sea Level as the elevation model in the receiver.

With the Pathfinder, Carlson Field will activate the receiver when the first Carlson Field command is run and the receiver will stay active until Carlson Field is exited. The reason is that the Pathfinder will turn off as soon as the COM port is turned off. If you need to make Carlson Field turn off the receiver, then use the Close Communication
With Pathfinder button.

With the Pathfinder, *DGPS Correction Source* selects whether the Pathfinder will get its Corrections from a local Coast Guard Radio Beacon or from the Racal Satellite Correction service. Note that the Racal option must be enabled on the receiver in order to use Racal satellite corrections. (See your dealer for details as to how to do so). If *Racal Service* is selected as the correction source, the *Racal Region* selection will be enabled. The region corresponding to the relative location of the receiver should be selected to ensure proper reception of corrections.

The Pathfinder and 4700/4800 also feature the ability to select a *Satellite Elevation Cutoff*. All satellites with elevations below this setting will not be used in the final position calculations, even if they are otherwise visible to the receiver.

For 4700/4800 series receivers, the *Receiver Type* option must be set to the correct model in order for Carlson Field to communicate with the receiver. *RTK Correction Type* selects what format of RTK corrections between the Base and Rover receivers. CMR and RTCM formats are available. *Radio Baud Rate* should be set to the same setting as the communication port of the radio connected to the receiver. 4800 bps, 9600 bps, 19,200 bps and 38,400 bps rates are supported. *Configure Base Station* will configure the receiver as a base and begin transmitting corrections via the radio.
Library Drivers - GPS

For library drivers, unlike the legacy Carlson Field GPS drivers, you select a Base or Rover driver from the Configure Field command (instead of inside the Equipment Setup dialog). A GPS Base Equipment Setup dialog is shown below.

General receiver options are configured under the Receiver section. There are input boxes for Antenna Height and Elevation Mask. The antenna height is the rod height of the GPS receiver. The elevation mask is specified in whole degrees (above the horizon, or 0 degrees). The Position Rate specifies the rate at which the GPS receiver will output positions or corrections. The available position rates vary from receiver to receiver.

The RTK section is used to setup the RTK configuration. First, select the RTK Device to be used, and click the Configure button next to it if you need to configure the radio (ie. channels, etc). Next, select the RTK Network (if applicable). If available, select the correct RTK Port and RTK Baud to define the connection between the receiver and the RTK device. Then, select the desired Message Type (correction type). Finally, enter a Base ID, or leave it blank for 'any base', and continue by. In the example below, the base receiver will be configured to output CMR corrections (Message Type) through the Internal Radio (RTK Device). The RTK Port and RTK Baud are grayed out because these are known values when using the internal radio on the Altus APS-3. RTK Network is not available in the example because it doesn't apply to the chosen RTK device. The Rover would be configured similarly to accept CMR corrections on it's internal radio.
To switch to the Rover, you must return to Configure Field > Equipment Type > Library Drivers and select the GPS Rover Manufacturer and Model. Similar to configuring a Base, general receiver options are configured under the Receiver section. In the example below, the rover receiver will be configured to receive CMR+ corrections from the KYTG NTRIP base over an internet connection using the receiver's Internal GSM modem (PLEASE NOTE: This is a separate example from configuring a GPS Base. The examples are not intended to show how to configure the same Base/Rover pair to work in a differential configuration, but are intended to show two entirely different types of configurations.). The RTK Port and RTK Baud are grayed out because these are known values when using the internal GSM modem on the Altus APS-3. The Message Type is grayed out because this is the only message type available from the KYTG NTRIP base. Also, in the example below, the user would be required to click the Connect button before exiting the Rover setup to actually connect to the NTRIP base and start receiving corrections.

Chapter 10. Field Module
Normally, the *Configure* button next to the *RTK Network* is grayed out, and the *Configure* button in the *RTK Base* section is used to configure any details about the Base that the Rover is receiving corrections from. However, *NTRIP* is slightly different. When using *NTRIP* as the *RTK Network* the *Configure* button next to the RTK Network is used to configure the NTRIP Broadcaster. The NTRIP Broadcaster is the server that actually broadcasts it's available NTRIP bases and their information. *Save and Exit* will connect to the displayed NTRIP Broadcaster and download the base list. *Exit* will keep the broadcaster you have selected, but will attempt to load the base list from memory and will not attempt to connect to the broadcaster to download the base list.

When using an NTRIP RTK Network, the *Configure* button in the *RTK Base* section will display NTRIP Base information to help the user select the best base choice. As shown below, NTRIP Base information usually contains a short name (Name), a descriptive name (Identifier), the NTRIP Base type (Type), available RTK message type (Format), and approximate NTRIP Base location (Position). The *Send Rover Position To Network* toggle is always grayed out, but displays whether or not the selected NTRIP Base requires the Rover position to be sent back (ex. this is typically required by virtual base systems). Once the preferred NTRIP Base is selected, click the *Connect* button to actually connect to the base to begin downloading corrections. After a successful connection is created, exit the Rover Setup dialog using the *OK* button. It is recommended to goto the Monitor/Skyplot routine to verify that the Rover is receiving corrections. The Rover's status will be Float or Fixed/Locked if receiving corrections.
Configure Base for All RTK GPS Brands

Within Equipment Setup, the Configure Base Station button is the command that starts the base receiver broadcasting GPS corrections to the rover. You must click the Configure Base Station button in Equipment Setup while you are connected to the base receiver. The base needs a set of coordinates to use as its stationary position. There are five methods to set the stationary base position: Read from GPS, Enter Lat/Lon, Enter State Plane Coord, and Read From Reference File and Read From Alignment File.

Read from GPS - This method takes one GPS reading from the base receiver's autonomous position and uses it as its "true" position. The autonomous position can be off of the actual position by 200 feet. The base will calculate corrections based on this autonomous position. If you set up the base with this method, the rovers must be aligned since the corrections they are using are based on a "true" position that is not really true.

Enter Lat/Lon - requires you to enter the latitude and longitude for the position of the base antenna. This is useful if you are setting up over a USGS monument whose lat/lon you know. It can also be used over a control point whose position is known from GPS post-processing.

Enter State Plane Coord - requires you to enter the State Plane northing and easting for the point that the base is occupying. This is useful if you are setting up over a USGS monument whose coordinates you know.

Read From Reference File - reads a previously saved base position file. All of the other methods of setting up the base let you save the base position at the end of setup. If you return to a site, set up the base in exactly the same position, use Read From Reference File to use the same base position and you don't have to re-align the rover: the old alignment is still valid.

Read From Alignment File - reads a position file from one of the control points in an alignment file. This allows you to setup the base on one of the control points from the alignment. Then you don't have to re-align the rover: the old alignment is still valid.
Method 1 - Read from GPS

Step 1
Pick Read from GPS

Step 2 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the correct port.

Base GPS receiver's autonomous position
Carlson Field takes a reading and displays the latitude, longitude and ellipsoid height. This is the position that the base will use as its "true" position. The base is now configured. If you are using Pacific Crest radios, the TX light on the radio should begin blinking.

Error Message if incorrect
If the GPS receiver is not properly connected, is turned off, or hasn't determined a position yet, you will see an error message. Check all connections and try again.

Step 3 - Save Settings to File?
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 2 - Enter Lat/Lon

Step 1
Pick *Enter Lat/Lon*.

Step 2 - Enter Lat/Long/Ellipsoid Height
Input the Latitude, Longitude and Ellipsoid Height for the base position. Pick North or South for the Latitude and East or West for Longitude. Important Note: The Latitude and Longitude entered must be within 100 meters of its true location on the globe. Ideally the entered base position should be a Latitude, Longitude and Ellipsoid Height from an accurate post processed static GPS point or a published NGS monument.

Step 3 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit *OK*.

Reminder Pop-Box
You are reminded to connect the radio to the proper port.

Base's Lat/Lon/Hgt position
The Lat/Long and Ellipsoid Height for the base position are displayed. These will be used for corrections and broadcast to the rover. If your radio has a TX light, it should begin flashing.

Step 4 - Save Settings to File?
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 3 - Enter State Plane Coord Step 1
Pick Enter State Plane Coord.

Reminder Pop-Box - Current Zone & Datum
You are reminded what State Plane Zone and Datum is loaded. If this is incorrect, exit Equipment Setup and input correct State Plane Zone and Datum in Configure Field > GPS Settings.

Step 2 - Enter Northing/Easting/Elevation
Input the State Plane coordinates (northing, easting and elevation) for the base position. Important Note: The State Plane coordinates entered must be within 100 meters of its true location on the globe. Ideally, the entered State Plane coordinates (N,E,Z) should be from an accurate post processed static GPS survey point or from a published NGS monument data sheet.

Step 3 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the correct port.

Base’s Lat/Lon/Hgt position
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used for the corrections that are sent to the rover. If your radio has a TX light, it should begin flashing.

Step 4 - Save Settings to File?
You have the option to save this base position as a file. You'll be able to use this file if you set up in the same spot in the future.
Method 4 - Read From Reference File

Step 1
Pick Read From Reference File to select an existing base position REF file.

Step 2 - Select Base Reference File to Load
Pick the base position REF file to be loaded. Use the up arrow folder to browse elsewhere for the REF file.

Position as Read from File
The latitude, longitude and elevation are read from the selected file and displayed.

Step 3 - Base Antenna Height
Enter the vertical height of the base antenna.
Step 4 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the selected port.

Base’s Lat/Lon/Hgt Position
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used to calculate the correction that are sent to the rover. If your radio has a TX light, it should begin flashing.
Method 5 - Read From Alignment File

Step 1
Pick Read From Alignment File.

Step 2 - Select Alignment File to Load
Pick the alignment DAT file to be loaded. Use the up arrow folder to browse elsewhere for the DAT file.

Step 3 - Select Alignment Point
The program will display a list of points in the alignment file. Pick the point from this list.

Step 4 - Base Antenna Height
Enter the vertical height of the base antenna.

Step 5 - Station ID (Optional)
If you plan on doing post-processing, you can input a Station ID for the base GPS Antenna location. Otherwise just hit OK.

Reminder Pop-Box
You are reminded to connect the radio to the selected port.

Base's Lat/Lon/Hgt Position
The Lat/Long and Ellipsoid Height for the base position are displayed. This position will be used to calculate the correction that are sent to the rover. If your radio has a TX light, it should begin flashing.
Saving Base Settings to a File

It is always recommended to save the base position to a file if you are going to return to the same site survey again. You can setup on the same base position, recall the base REF file and enter the new antenna height. Then you can use the alignment file from the first day in the rover and not have to re-align.

When you save the base antenna position to a file it is stored with a REF extension denoting base reference file. By default, it goes in the Data directory. Input reference filename and pick \textit{Save} and \textit{OK}.

Configuring the Rover

After the base is configured, unplug the base receiver from the Carlson Field computer and plug in the rover receiver. In Equipment Setup, toggle the \textit{Station Type} from \textit{Base} to \textit{Rover}. Then pick \textit{Exit}. This will configure the receiver as a rover.

From the Field drop-down, pick the command Monitor GPS Position. The Status is reported as either Autonomous, Float or Fixed.

If the rover is Autonomous, it is not getting any corrections from the base.

If the status is Float, the rover is receiving corrections, but has not found the fixed solution. Once the solution becomes Fixed, the rover is locked on to the base corrections and is calculating an accurate position.

Align GPS To Local Coordinates

Carlson Field reads a latitude, longitude and height position from the GPS rover receiver and converts these values to State Plane or UTM coordinates for the current zone as set in \textit{Configure Field}. Using local coordinates and their corresponding GPS position, \textit{Align Local Coordinates} applies a transformation to convert the state plane or UTM
Carlson Field can operate in three different modes depending on the Align Local Coordinate settings:

1) No points - No Adjustment
2) One point - Translation Only
3) Two or more points - Translate, Rotate and Scale

Without any alignment points set, Carlson Field will operate with no alignment which directly uses the state plane or UTM coordinates. In order for the coordinates to be the true state plane coordinates in this alignment mode, the GPS base receiver must be set up over a known point and the true Lat/Long for the point must be entered in the base as the base position. Otherwise, if the base is set over an arbitrary point, then the coordinates will not be true state plane.

In one point alignment mode, one pair of GPS and local coordinates is specified. The differences between the GPS and local northing, easting and elevation for these points are used as the translation distances in the transformation. The rotation will use either the state plane grid or the geodetic as north. No scale is applied in this transformation.

A two or more point alignment is used to align to an existing local coordinate system. At least two pairs of local and GPS coordinates must be entered.

In addition to the northing and easting transformation, SurvStar will also translate the elevation from the GPS system to the local. The elevation difference between the two systems is modeled by a best-fit plane.

An alignment is only valid if the base receiver setup has not changed since the alignment points were recorded. In order to use an alignment when returning to a site, you must set up the base receiver in the same position and enter
the same LAT/LONG coordinates for the base.

The Align GPS to Local Crds menu item brings up the alignment dialog box. There is more information than to fit in one window, so use the View button to switch between viewing the local coordinates and the GPS Lat/Lon.

Each line in the box represents one alignment point. Each point in an alignment file relates a specific Lat/Lon/Elv to a specific Northing/Easting/Elevation for your local coordinate system. Carlson Field will use the current alignment file every time that the GPS is read. It provides the necessary adjustment to properly convert that position to your coordinate system.

In the local points view, the HRes column shows the horizontal residual and the VRes column shows the vertical residual. The residual is the difference between the actual point and the point calculated using the alignment transformation. In GPS points view, the HRMS and VRMS columns show the horizontal and vertical RMS values when that point was recorded.

The On/Off buttons allow you to switch whether the highlighted point is used for the horizontal and/or vertical alignment. The HV column shows a ‘Y’ if this point is used in the calculations. Otherwise it shows an ‘N’. The H column represents horizontal control and the V column vertical control. For example, you may wish to use 2 points for horizontal alignment and one for vertical.

The Optimize button will find the combination of turning alignment points on/off for horizontal and vertical such that the horizontal and vertical residuals are minimized.

The Desc field shows an optional description of the alignment points.

The scale factor and average horizontal and vertical residuals appear at the top of the window. These values serve as a check that the alignment is valid. The scale factor should be closed to 1.0 (in range of 0.9 to 1.1). The average residuals should be less than 0.2.

XY On/Off toggles the highlighted alignment point horizontal component off or on. Alignment points with the horizontal component toggled off will not use the northing and easting of that point for adjustment calculations.

Z On/Off toggles the highlighted alignment point vertical component off or on. Alignment points with the vertical component toggled off will not use the elevation of that point for adjustment calculations.

Note: When you toggle either the XY or Z component off or on for any alignment point the scale factor and Horiz/Vert residuals are recalculated automatically. Briefly toggling XY or Z components off or on and reviewing the scale factor and residuals changes is a quick approach to finding the best alignment points. Carlson Field can handle an unlimited number of alignment points.

Highlight an existing alignment point entry and pick Delete to delete that alignment point.

Pick the Add button to create an alignment point. The Add Alignment Point dialog box appears. There are two ways to enter the local coordinate points: by entering the N, E, Z, or by using an existing point number stored in the current coordinate CRD file. The GPS values can also be specified by two methods: by entering in the Latitude, Longitude and Height or by occupying the control point with the rover and taking a GPS reading at this location. Manually entering the Lat/Lon can only be done when the base is setup on a known location using a true lat/lon position. Otherwise Carlson Field needs to use the Read GPS method. For this method, the base can be setup with a lat/lon that only needs to be close (within 100 feet) of the actual lat/lon. This type of position can be read from an autonomous GPS position. With the base setup on this approximate lat/lon, go with the rover to the control points and use the Read GPS option in the Add function. The rover GPS solution must be in "fixed" status when the alignment point is added. By reading the rover GPS position for the alignment points, the alignment will transform the coordinates from the GPS system of the current base setup to your local coordinate system.

Load allows you to open an existing alignment file. Only one alignment file can be open at a time. Alignment files have a DAT extension and stored in the Data directory by default.

Save stores alignment files (DAT extensions) to a file. Files are by default stored to the Data subdirectory.

The OK button will set the current alignment to the settings in the dialog.

Alignment Methods

Carlson Field can operate by the following Alignment methods:
Alignment Method 1

With no alignment of the rover, Carlson Field will report Northing and Easting as State Plane or UTM coordinates. In order for this method to give accurate State Plane or UTM coordinate values, the GPS base receiver must be set up over a known point and configured using the true Lat/Long/Hgt or true State Plane coordinates. If the base is set over an arbitrary point, configured by reading the GPS, the RTK GPS stored coordinates will be translated up to a 200 feet but accurate in relation to each other.

When using this method, you can skip Align GPS to Local Crds and start surveying immediately once the base is configured and transmitting its position and the rover is fixed.

In most cases, you cannot use Method 1 because you will not have setup the base on a point whose exact true position you know. Therefore the base corrections are going to be off a certain distance north/south and a certain distance east/west. This is why you want to do an alignment. You are showing Carlson Field how to correct for the north/south and east/west offsets. Any points surveyed with the alignment file active will be translated to their proper position.

To gather alignment points, you put the GPS antenna over a point with known coordinates and Carlson Field records the GPS Lat/Lon/Elv and the Northing/Easting/Elevation you give it. This point can be a local coordinate, for example a stake you are calling 5000,5000. It can also be a true State Plane point. Using one or more State Plane points will give you an alignment to true State Plane (even if your base is not using its own true position.)

Alignment Method 2

This method uses one alignment point to translate the GPS coordinates to local or true State Plane coordinates.

Remember that if the base is set up over an arbitrary point, the GPS coordinates can be off from true state plane by up to 200 feet. This alignment method can be used to correct for this by translating the system onto true state plane coordinates.

You can choose if you want the coordinate system North to be Geodetic North or State Plane Grid North under Configure Field>GPS Settings. If you specify a scale factor in that dialog box, it will be applied to all points recorded.

One point alignment is useful for data collection on a new site. In this case you can set up the GPS base receiver anywhere convenient. Then position the rover over a point (preferably one you can find again) and add this point as your one alignment point by reading the GPS point and entering a local coordinate like 5000,5000,100. Now the local coordinate system is set around this first point at 5000,5000,100.

This method is commonly used for small topo or stockpile RTK GPS surveys. When collecting or staking data at distances greater than 2 miles from the base, both the horizontal and vertical errors will begin to increase gradually. Therefore, you should use a multiple point alignment for large projects.

Alignment Method 3

This method is useful if you are arriving on a job which has already been surveyed. It assures that your survey is in the same coordinate system as the original survey.

Using control points, this method transforms the GPS coordinates to an existing local coordinate system. This method takes pairs of GPS coordinates and the corresponding local coordinates to define the translation, rotation and scale of the alignment.

In Configure Field>GPS Settings, there is a choice for the transformation as Plane Similarity or Rigid Body. Plane Similarity will apply a scale factor to the transformation. The scale factor will be based on the alignment points and should always be very near 1.0 to be correct. The Rigid Body option will align by translate and rotate but no scale. Any difference in scale between the GPS and local coordinate systems will be distributed equally between the two alignment points. These differences will appear as horizontal residuals in the Alignment dialog.
Two pairs of points are sufficient to define the translation, rotation and scale for the transformation. But adding more alignment points yields the most accurate results for aligning to existing coordinate systems. Since two pairs of coordinates are sufficient to define the transformation, there is extra data when there are three or more pairs. The program uses a least-squares best-fit routine to find the transformation that minimizes the residuals. This one best-fit transformation is used to convert from the GPS to the local coordinate system for all the points. The residuals are the differences between the transformed GPS coordinates and the actual local coordinates.

A multiple point alignment is especially helpful on a survey which covers a large area. The error in raw GPS coordinates increases as you get farther from the base. Taking alignment points around the perimeter of your job site as alignment points will give you the best geometry for the alignment.

**Point Store**

This function creates points by reading from GPS or total station equipment. The new points are stored in the current coordinate and simultaneously drawn in the drawing. The measurement data is also stored to the current raw file which has the same name as the coordinate file except with a .RW5 instead of .CRD file extension.

The Point Store dialog docks on the side of the drawing window. This allows you to see the drawing view as you collect points. You can use the arrow keys to pan the drawing and the Page Up/Page Down keys to zoom out and in. There are also icons for the pan and zoom functions at the top of the dialog. Also, besides clicking the function buttons, most buttons have an associated function key such as F1 that you can use to run the routine.

Before taking measurements, make sure that the rod height is correct.

To take a measurement from the survey equipment, pick the Read button. The calculated northing, easting and elevation will be displayed in the dialog and a temporary icon will be shown in the drawing at the point location.

Before storing the point, make sure that the point number and description are set in the Point Number and Description fields. The point number is a required field for storing to the current coordinate file. If the point number specified already exists in the coordinate file, then a dialog will pop-up with options to overwrite the existing point number, to use another point number or to cancel storing the new point. The Point Number field will automatically increment after storing the point.

The Description is an optional field for identifying the point. The maximum length of the description is 32 characters. Besides naming the point, the description can also be used to with Field-To-Finish to draw linework and to determine the symbol of the point in the drawing. When the Field-To-Finish option is set on in Options, the program will lookup the description in the current code table. If the description matches one of the codes, then the code can determine the symbol, layer, format of the point when it is drawn. Otherwise the defaults in the Point Setting section of the Options dialog are used for the point symbol, layer and format.

To store the new point to the coordinate file and draw the point, pick the Store button. At the time that Store is applied, the program uses the point number, description, linework options and special options currently set in the dialog.

You can also use the Read & Store button to do both functions in one step. With this method, the program will take a measurement and if the measurement is successful, then the point will be stored immediately.

The Code button brings up a list of point descriptions from the current Field-To-Finish code table. You can select a code from the list to set this code as the current point description. This function also shows a list of all the descriptions of currently active linework. You can end a currently active linework by highlighting the linework description from the Active Linework list and pressing the End Linework button.
Many of the options for storing points can be set in the Configure Field>Point Settings command. The Options button in this dialog is a shortcut to these point settings.

If you want lines or polylines to connect the points that you are about to record, select the Start button under Linework. After the first point, the Linework selection will change itself to Cont meaning continue. Leave this selected while you are recording points in the same line. Before shooting the last point in your line, change it to End. If you want the line to close itself onto its first point, check the Close button.

The Field-To-Finish Linework option is an automatic way to start linework. The program will lookup the point description in the code table. If the description matches a code and the code is defined to create linework, then the Start toggle in the Linework options is turned on. Otherwise you can begin new linework by toggling on Start manually.

When a point is stored and Start is on, Carlson Field pops-up a dialog for choosing between a line, 2D polyline or 3D polyline. A 3D polyline can contain points with different elevations, but a 2D polyline always has an elevation of zero. The Smooth Polyline option will create Bezier smooth polyline through the points.

Carlson Field can keep track of several lines being drawn at once. Each line corresponds to a set of points with a different description. Let's say you are shooting a line of points called "fence" and you want to shoot some points on a curb, but you're not finished with the fence. You change the Desc box from "fence" to "curb". Carlson Field lets the fence line go for now. It changes the Linework selection to No. You want a line for your curb, so you select Start. The points you shoot now will form a new curb line. To go back to recording fence points, change the description back to "fence". The fence line you were working on will continue to include any new fence points you shoot. If you want to end this fence line, select End under Linework and Carlson Field will not connect any future "fence" points to this line. If you start a new linework with a description that already has linework, then Carlson Field pops-up a dialog with three options as shown. The Continue Existing Code option is the same as using Cont instead of Start. The End Existing and Start New option will end the active linework and start the new linework with the same description. The Use New Description option will keep the existing linework and start another linework with another description. For example if you are surveying two edge of pavement lines, you can have one with the description "EP" and the other with "EP2".

The PC and PT options are for drawing curves. If you want to plot a curve, check the PC box before recording the first point on your curve. Shoot as many points along the curve as you need. Carlson Field can handle compound curves as well as simple curves with this function. Before shooting the last point on the curve, check the PT button. If you don't specify a PT, Carlson Field will assume a three point curve.

Similar to Field-To-Finish linework, when looking up the point description in the code table, if the description matches a code and the code is defined to use data collection codes, then the Offset and/or Rotate toggles in the Special options are turned on. Otherwise you can create an offset and symbol rotation by toggling them on manually. Offset is for defining a left/right offset or an azimuth based offset. It also has the option for a vertical offset. Rotate will control the rotation angle of the symbol that is drawn when the point is stored; if enabled, the drawn symbol will be rotated based on the current heading of movement.

The Undo button will remove the last point number created. The point is removed from both the coordinate file and the drawing.

For GPS and tracking total stations, there is a Start Continuous button which makes Carlson Field continuously read from the instrument. The coordinates are displayed in the dialog and your position is shown with an arrow icon in the graphics view. To store a point, you can use the Store button without using the Read button first. Once continuous reading is active, the button changes to Stop Continuous which will put you back in standard reading mode.

Point Store with GPS
When using GPS equipment, Carlson Field will also report the RMS values and solution status when you take a reading. If Carlson Field gives you a message that your RMS values are too high when you try to read a point, you can click on the Monitor button to bring up the Monitor window which will give you information on how accurately your position is determined and how many satellites you are tracking. The Skyplot button will bring up the window showing you where in the sky the satellites are.

For points that are hard to reach directly by GPS, you can use the Offset option. This option can be used in areas of limited satellite communication such as high walls or under a tree. This allows you to setup the rover in a clear area and read the coordinate. The point that is actually stored is offset from the rover position. To create an offset point, turn on the Offset toggle and then choose Read. The offset direction can be entered as left, right or azimuth. The left and right offset is relative to the rover position at the previous read. The offset distance is entered in the dialog. A Vertical Offset can also be specified. Choose Store to store this point after the offset is done.

Offsets can also be done with laser guns when the laser option is setup in Configure Field>GPS Settings. There are two methods for taking laser offsets. One method is to use the Offset toggle and the Read button. In the Offset dialog, there is button for Read Laser for using the laser measurement for the offset distance and/or angle. This method creates a single offset point.

The other method is to use the Laser button which can create many offset points. This method brings up another dialog. The Setup button can be used to set the Laser Alignment Azimuth. This alignment applies to laser guns that use a magnetic compass for the horizontal angle. The magnetic north can vary from the north of your coordinate system. The Laser Alignment Azimuth is added to the measured laser azimuth to adjust for the difference. To set the alignment azimuth, specify a reference backsight direction by either entering an azimuth or by point number. Then choose the Read Laser For Alignment button and take a laser shot towards the backsight. The program will compare the azimuth from the laser with the reference backsight to figure the alignment azimuth. When the alignment azimuth is set, pick the Go button. Carlson Field then listens for measurements on the laser gun port. To take a shot, sight the target point and press the laser trigger. Carlson Field will read the laser measurement and read the GPS position. The laser angle and distance are combined with the GPS position for the new point coordinates. To return to regular GPS Point Store, choose the Exit button.

**Point Store with Total Stations**

Before taking measurements with total stations, you need to specify the occupied point coordinates of the instrument, the backsight and the height of the instrument. This current setup data is shown in the "OC:# BK:# HI:#" line in the dialog. Also icons are draw to show the occupied point and backsight direction in the drawing view.

The Setup button at the top of this dialog brings up the Total Station Setup dialog, where you can change your occupied point, backsight and instrument height.

For robotic total stations, there is also a Joystick button to turn the instrument, search for the prism and set tracking or standby mode.

Carlson Field can shoot points with offsets. To shoot a point with an offset, check the Offset button on the Point Store dialog box. Click Read or press F1. A window appears to let you choose the type of offset to shoot. The choices are Distance/Angle and Enter Offset Distances. The Offset Vertical option will prompt for an elevation difference to apply to the point.

To do a Distance/Angle offset, you first take a distance shot and then angle shot. For the distance measurement, have the rodman stand to the side of the point. The prism and the point should both be the same distance from the total station. Carlson Field takes the first shot and gets the distance from it. It then prompts you to read the angle. Turn the gun so that it is aimed at the point. The prism is not needed for this step. Click OK and Carlson Field reads the horizontal angle from the gun and combines this with the distance from earlier to calculate the coordinates of the point. Also for combining these shots, there is an option whether to use the vertical angle from the distance or from the angle shot.
With the Enter Offset Distances method, you can supply both a left/right offset and an in/out offset. To do an In/Out offset, have the rodman stand a measured distance in front of or behind the point. The total station will take the shot and then Carlson Field will ask you how to move the point: in or out and the distance. If the prism is in front of the point, choose out. If it’s behind the point, choose in. To do a Left/Right offset, have the rodman stand a measured distance to one side of the point. After taking the shot, Carlson Field will ask whether to offset right or left. If you are at the total station, looking at the prism, and the point you are after is to the right of the prism as you’re looking at them, choose right offset. Otherwise, choose left offset.

Choose Store to store this point after the offset is done.

The D&R option stands for Direct and Reverse. When this box is checked, Carlson Field will take sets of four shots to determine the coordinates of the next point. Two shots are taken for both the backsight point and the foresight point: one direct shot, one shot with the total station reversed. This yields a more accurate reading. Two options are available for the order of shots when doing a D&R. The first is Backsight Direct, Backsight Reverse, Foresight Reverse, Foresight Direct. The other option is Backsight Direct, Foresight Direct, Foresight Reverse, Backsight Reverse. Carlson Field also offers the option of shooting multiple sets of Direct & Reverse for even greater accuracy. The Shoot Distances For Reverse Shots option determines whether to take distance measurements on the foresight reverse and backsight reverse shots. When this option is off, the program will still use the reverse shots to mean the angles. Otherwise the program will also use the reverse shots to mean the distances. The Use Robotics To Auto Flip Instrument option applies to robotic total stations to have the program automatically turn the instrument for reverse shots.

To shoot a point as a Direct & Reverse, check the D&R box and click on Read. A dialog box appears, offering the choice of orders for the shots. Before each shot, Carlson Field tells you what kind of shot is being taken. After each shot, Carlson Field reports the measurements and allows you to confirm the measurement or to re-shoot. After all four shots are taken, Carlson Field does the math and reports the accuracy of each part of the measurement.

Choose Store after completing the Direct & Reverse to store this new point.
The Stakeout function is used to find a specific point in the field. Once you tell Carlson Field the point that you are looking for, pick Start and the program draws an X-marks-the-spot bullseye on that point in the drawing. Carlson Field also draws a triangle on the drawing for where you are currently standing. These icons help to guide to the target point graphically. Carlson Field also reports in the dialog box how far you need to move to reach the point.

There are several options for Stakeout defined in Configure Field > Stakeout Settings. These options should be set by Configure Field before running Stakeout. See the Configure Field section of the manual for a description of the stakeout options.

There are four ways to define the target point for stakeout. The first method is to specify a point number from the current coordinate file. To do this, click on the Point Number button and type in the point number in the dialog. The second method is to give a station and an offset from a centerline. The program will prompt for a centerline file (.CL) and then the station and offset. You can also specify the station interval for automatically incrementing to the next stakeout point. See the Roads section of this manual for how to create centerline files. The third method is to graphically pick the point from the drawing. Select Pick Point and a dialog box allows you to pick different snaps: endpoint, midpoint, center, node (point), or intersection. This will help you pick your desired point more accurately. For example, you can select endpoint and then pick on a polyline corner to stakeout that the polyline endpoint. See the Object Snap command on this manual for more on snaps. The fourth method is to simply type in the target point coordinates in the Northing, Easting and Elevation fields.

Once the stakeout point is set, click the Start button and Carlson Field begins the stakeout routine. The format of the stakeout screen that appears depends on whether you are using total stations or GPS as described below.

When you reach the target point, click the Store button. Carlson Field reports the difference between your current position and your target position. At this point you can choose to store this staked-out point as a new point in the coordinate file.
When the target stakeout point has an elevation, Carlson Field also reports the elevation difference between the target and current elevations. This cut/fill is also in an edit box that allows you to change the value for labeling. For example, you may want to round the cut/fill number to an even number to label on the stake with a mark to indicate where this even number occurs. When you change the cut/fill label from the original value, Carlson Field will report the offset for this mark. For total stations, Carlson Field will also report the zenith angle for locating this mark. There are also fields in the report dialog for entering vertical offsets to get additional cut/fill values. For example, if the target point is for the road surface and you want to also get the cut/fill to an 18 inch subgrade, then enter -1.5 as the vertical offset.

**GPS Stakeout**

After you click *Start* to begin staking the point, Carlson Field changes the dialog box to the one shown below. The dialog shows the target point, the current position northing, easting and elevation and the GPS HRMS/VRMS. The distance, azimuth and cut/fill from the current position to the target are also reported. Carlson Field also breaks down this distance into how far north/south and how far east/west to go. Finally based on your current heading, the program tells you whether to turn right, turn left or that you are on-line.

In the graphics view, the large "X" shows the point being staked-out and the triangle represents your position.
temporary line is drawn between your current position and the target. In Configure Field>Stakeout Settings, there is an option to auto zoom in as you approach the target point. Otherwise you can use the arrow keys to pan the display and the Page Up/Down keys to zoom out and in.

**Total Station Stakeout**

Before starting the stakeout, be sure that the instrument is setup with correct occupied point, backsight and instrument height. This setup data is displayed in the third line of the dialog. You can pick the Setup button to change the instrument setup.

After you click Start to begin staking the point, Carlson Field changes the dialog box to the one shown below. The dialog shows the angle to turn the gun and the horizontal distance to the target. Turn the instrument to this angle and position the rodman at this angle and distance. Then pick the Read button to take a measurement. Carlson Field will then report the horizontal distance and cut/fill from the current position to the target. This distance is also reported as how far north/south and how far east/west to go and as how far in/out and left/right to go. To in/out and left/right distances are relative to the rodman facing the instrument. Keep moving the rodman and picking the Read button until you reach the point. Then pick the Store button.
For robotic total stations operating remotely, there is a Continuous button that puts the instrument in tracking mode with continuous measurements.

In the graphics view, the large "X" shows the point being staked-out and the triangle represents your position. Also the location of the instrument is shown with an icon and the backsight is shown as temporary line.

**Auto Points at Interval**

This command stores a point whenever the distance or time from the previous point exceeds the user-specified interval. This command only applies to GPS and robotic total stations. If you will be collecting a large number of points at once, *Auto Points at Interval* can be a useful tool. For example, you may want to plot the edge of a road. Once you start *Auto Points*, you can walk along that edge of road and let Carlson Field record your position automatically.

The *Auto Points at Interval* dialog box resembles the *Point Store* dialog box with the addition that you can set the interval to record points. You can set it to store a point every time you move a certain distance by selecting *Distance* and entering the distance you choose in the *Interval* box. The distance will be taken in feet if your project is using English units, or meters if your project is in Metric. If you select *Time*, the number in the *Interval* box will refer to
the number of seconds between creating points.

Check the Draw Linework box to have your points connected by a line or polyline. You can enter a description or choose from the code table just like in Point Store.

The Offset toggle will apply an offset to the calculated coordinates. The horizontal offset is applied perpendicular either left or right to the direction of movement. There is also an option for a vertical offset.

The Rotate toggle will rotate each drawn symbol in reference to the current heading.

If the description contains a Field-to-Finish code, the Offset and Rotate toggles will be selected/unselected automatically based on that code's Data Collection Code settings.

Pick Start to begin storing points. Carlson Field will take a reading and store the first point. Then Carlson Field will continuously read the GPS or total station. For distance interval method, as each point is read the distance from the last point is calculated. When the distance is greater than the specified interval, a point is created and the point number is displayed in the dialog. In practice, the actual distance between stored points will be greater than the distance interval. For example, if the distance interval is 10 and the current distance is 8.9, then no point is stored. Then you keep moving and the next distance is 11.4 which will store a point.

For time interval point storing, after reading and storing the first point, Carlson Field will wait for the interval time to pass, then read and store again.
The new points are both stored to the current coordinate file and drawn in the drawing.

When using GPS, if the RMS values of the position read are above the tolerance set in Configure Field, then the point will not be stored.

Carlson Field will continue to record points until you click on Stop.

**Track Position**

This command shows the coordinates of your current position in a dialog and draws an arrow icon in the drawing view. This command only applies to GPS and robotic total stations. As you move along, the arrow icon will move through your drawing showing your position in real-time. If the arrow icon gets near the edge of the screen, Carlson Field will automatically pan over.

A dialog box also appears in Track mode. The dialog shows your current northing, easting and elevation. For GPS mode, the dialog displays the **HRMS** and **VRMS** values and solution status. There are buttons to take you to Monitor and Skyplot. There is also a Store button which will store your current location as a point and plot it, similar to the Point Store function.

**Satellite SkyPlot**

When using GPS, it is important to know how many satellites you are tracking and their position in the sky. Satellite Skyplot's visual and graphical screen aids in identifying when satellites are being masked by surrounding structures, trees and mountains. Satellites close to the horizon, under fifteen degrees, are less helpful resolving the rover
position because of extra atmospheric interference. If there are too few satellites present, the receiver will be unable
to resolve its position. Typically five satellites are required to resolve position and four are needed to maintain locked
solution. *Satellite Skyplot* can be an invaluable tool to help you monitor the current satellite configuration.

The skyplot screen appears at left. The top half of this window displays the visible satellite information in chart
form. *PRN* is the satellite identification number. *Azi* is an abbreviation for azimuth; the horizontal angle from due
north, in degrees measured clockwise, to the satellite position (0 to 360 degrees). *Elv* is an abbreviation for elevation;
the vertical angle above the horizon where the satellite can be found (0 to 90 degrees). One entry appears for each
satellite that the receiver is tracking.

The image on the lower half of the window displays the same information graphically. It shows a map of the sky
with North at the top, East to the right. The centerpoint, where the lines cross, is straight up. Each satellite appears
as a symbol resembling an "H". As you can see, most of the visible satellites were in the Northeast when this image
was captured. The inner circle represents an elevation of sixty degrees. The outer circle is the horizon. Roughly
speaking, any "H" touching this circle is too low in the sky to be of much use. For GPS receivers that support
GLONAS satellites, Skyplot will show these satellites with a "G" symbol.

For some types of GPS receivers, the receiver will report which satellites are being used for calculating the position
and which are only being tracked. A satellite might be only tracked and not part of the solution if the satellite is
too low on the horizon or when the signal is not clear. The skyplot will highlight the satellites that are part of the
calculations.

**Monitor GPS Position**

This command reports the current GPS Lat/Lon, local coordinates and GPS solution status. The latitude and lon-
gitude are reported in the DD.MMSSSSSSSS format. In this example, the latitude is 42 degrees, 21 minutes, 46.4414
seconds north. The longitude is 71 degrees, 8 minutes and 31.5699 seconds west. Negative longitudes indicate
longitudes west.

The next three items are state plane or local coordinates depending on the transformation in the Align Local Coor-
dinates command. The *HRMS* and *VRMS* are measures of the reliability of the position that the receiver has calculated.
They correspond to the position horizontally and vertically, respectively. If the receiver is autonomous, not receiving
corrections from a base, the RMS can be up to a few hundred feet. If this rover is computing a "Fixed" position,
the RMS values should be less than one foot, probably close to a tenth of a foot. If the receiver looses the fix and
becomes "Float", the RMS values will jump to between one and ten feet.

Depending on the type of GPS receiver, the Monitor screen will also show more values like radio link status and
The *Skyplot* button will jump you to that window so you can see the satellites the receiver is using.

**Benchmark**

This command takes a measurement to a benchmark point with a known elevation in order to calculate the elevation at the occupied point. This command only applies to total stations.

In the Benchmark dialog, fill in the instrument and rod heights. The benchmark elevation is specified in the Target Elevation field. This field can be filled out by entering a target point number which reads the elevation from the current coordinate file for the specified point. Or you can simply type in the target elevation directly. There is a choice between calculating the occupied point elevation or the instrument height. For calculating the instrument height, you need to enter the occupied point elevation. When calculating the occupied point elevation, there is an option to store this elevation to the coordinate file for the occupied point number. When all the options are set and the target benchmark is sighted, pick the Read button to take a measurement. After the reading, the program will display in the dialog the calculated occupied point elevation or instrument height depending on the calculation mode.

**Resection**

Resection is used when setting up a Total Station on an unknown point. The occupied point coordinates are calculated from two or more angle and distance measurements to known reference points. This command only
applies to total stations.

The dialog above has options for *EDM Mode* and *Robotics*. These options will only show up for supported total stations (ie. robots, etc).

*Configure Std Errors* can be used to set standard errors for the measurements, as shown below. These settings allow you to take advantage of network least squares and weighting in the resection calculation. The default values are shown below:

Reference points are distinct known points that are measured to calculate the unknown occupied point. Direct and Reverse measurements are optional by using the toggle *Direct and Reverse* located in the *Add Reference Point*.
Reference points can be specified in several ways:

1. Manually entered point number
2. Selected from a list of points stored in the coordinate file (via List button)
3. Picked from the CAD screen (via Pick button)
4. Manually entered coordinates (via Create button)

There are input boxes for the target (or rod) height, and instrument height. The Store Picked Points toggle controls whether or not the user is prompted to store screen picked points that are not found in the coordinate file.

After a reference point is chosen, its description and coordinate information are displayed. Press the Read button to initiate the measurement for the currently displayed reference point. After a successful measurement, the user will be prompted to verify the measurement information. This gives the user a chance to verify the target (or rod) height, and the option to discard the data and take another measurement. The user will be prompted to determine whether or not to zero the instrument on the first reference point.

A minimum of two distinct reference points and measurements are required to calculate the occupied point. The calculated occupied point information is displayed in the Resection Results section. The input data is displayed in a list structure and the user has the option to turn certain measurement on or off using the On/Off button or remove an unwanted measurement using the Remove button. The resection results are calculated automatically anytime a reference point measurement is added, a list item is removed, or a list item is toggled on or off. A resection with three inputs 'on' and one input 'off' is displayed below:
The **Resection Results** section shows the calculated occupied point's northing, easting, and elevation and the difference between the calculated coordinate and the individual solutions as the residuals. The residuals indicate the quality of the data. High residuals suggest a problem with the input data. When you press the **OK** button, you will be prompted to verify the calculated occupied point. If accepted, the calculated point will be stored to the coordinate file and you will be setup on the calculated point backsighting the first point shot in the resection.

**Building Face Surface**

Used to project all points onto a surface or plane. Upon executing the function, a menu will open, prompting the selection of three points to define the plane/surface. Note that there must already be three points along the plane in the CRD file in order for this function to work properly. After selecting the three points (the "List" buttons will bring up a list of available points), select "OK" to proceed. A screen similar to the Store Points dialog will now open. Every point which is read will be plotted along the plane defined by the three points selected, even if it is at a different distance. When finished, simply exit out of the menu as with any other function.
Pattern Point Survey

Used with a reflectorless Total Station. This function is used to shoot a regular, rectangular "pattern" of points across an area. It is useful when periodic measurements of an area are required. Upon starting the function, a query box will ask for two point defining a rectangle, the lower left corner and the upper right corner. For each of these, aim the gun at the corner of the area to be scanned and click "Read". After reading both points, a menu will prompt for several other parameters. Enter the first point number to shoot, as well as any desired description for the points, and both horizontal and vertical increments. These are angle increments, given in seconds. Once all of the above is entered, select "OK" to begin the survey. The total station will now begin turning automatically to the bottom-left corner of the area, and will begin shooting points. Upon reaching the right-hand limit of the area, it will begin a new row of points, starting at the left.

Point Check By Robotics

This command works with robotic Total Stations made by Leica, Topcon or Geodimeter. This function is used to shoot and record a series of known target points. Before running this command, the instrument setup must be set (occupy point, backsight) with the Equipment Setup commands. After selecting Point Check by Robotics you will be prompted with a dialog box. Choose the points you want to check and click process. The Total Station will then go from point to point and take new measurements. When it is all done, a report will be given with the new measurements and any deviation.

Carlson Field Icon Menu

The Carlson Field Icon Menu lets you select Carlson Field functions by pressing a function key F1-F10 or by picking the icon button. The set of commands that are available in this menu depends of the type of survey equipment that you are configured to. Before running these Carlson Field functions, you need to run Configure Field to set the equipment type and communication parameters.

There are two ways to bring up the icon menu. One way is by picking the Start Carlson Field icon. This start icon is displayed in the lower right of your screen when the Show Startup Icon option is on as set in Configure Field under General Settings. You can close the Start Carlson Field icon for the current drawing session by clicking the
X in the icon title bar. To bring back the Start Carlson Field icon you can use the F11 key. The Start Carlson Field icon is only displayed when no commands are running. The other way to show the Carlson Field function menu is to pick the Menu(F11) button while running other Carlson Field commands. This method allows you to switch between Carlson Field functions without having to exit back to the CAD menu. For example, you can switch from Point Store directly to Stakeout.

This is the function menu when using a non-robotic total station or laser equipment:

This is the function menu when using a robotic total station:
This is the function menu when using GPS equipment:

**Typical Alignment Scenarios**

**Scenario:** New site. In this case, there are no established coordinates on the site.

**Alignment:** Choose a point on site and do a one point alignment. For the local alignment point, enter the coordinates that you would like to use (ie 5000,5000,100). Under Configure Field>GPS Settings, The One Pt Align Azimuth option chooses between using true north (geodetic) or state plane north (grid). To use real world ground distances, set the Project Scale Factor under Configure Field>GPS Settings. Otherwise the default scale factor of 1.0 will collect points on state plane distances.

**Scenario:** One known state plane coordinate and you want to work in the state plane coordinate system.
Alignment: Either setup the base over the known state plane coordinate or do a one point alignment on this known state plane point. In Configure Field>GPS Settings, set the One Point Align Azimuth to Grid and set the scale factor to 1.0.

Scenario: Multiple known control points.

Alignment: Choose two or more control points to align to. It is best to use control points around the perimeter of the site. Use as many control points as are available or enough to envelope the site. In Configure Field>GPS Settings, set the Transformation to Plane Similarity to fit the GPS points onto the control points and set the Project Scale Factor to 1.0. After making the alignment, stake out another control point (ideally one that is not used in the alignment) to make sure the alignment is good.

Surface Menu

The Surface pull-down menu has Elevation Difference and surface creation commands that are described in the Civil Design manual.

### Elevation Difference

This command reports the cut or fill between your current position and a design surface. The design surface can be one flat elevation, a grid file, a triangulation file, a road design file, or a section file.

The type of design surface is set in the dialog shown. The Vertical Offset in this dialog can be used to modify the design surface by adding this value to the design surface. For example, if you have a design surface for the top of a road and you want to get cut/fill values to a 1.5 subgrade, then enter -1.5 in the Vertical Offset field. The Use Centerline For Station-Offset option will report the station-offset of your current position in addition to the cut/fill. When this option is active, the program will prompt you for the centerline file (.CL) to reference. For GPS and robotic total stations, the Auto Store Points At Interval will creates points whenever your position moves by more than the specified distance or time interval. This option is similar to the Auto Points At Interval command with the addition that the default description will include to cut/fill to the design surface. When all the options are set, pick OK and the program will then prompt you for a grid file or triangulation file if you have selected these types of design surface.

**Elevation Difference with GPS**

Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position. Carlson Field finds the design elevation for this point and compares it to the elevation being reported by the GPS receiver. It then tells you how much cut or fill is required to reach the design elevation from your current position. An arrow icon will appear on the drawing showing your location. You can move around the site while in *Elevation Difference* mode and Carlson Field will report the necessary cut or fill in real-time. If you
move off the area covered by the design surface, then the program will stop reporting cut/fill and instead will report "Off Surface".

The Store button will create a point at the current position. The default description will include the current cut/fill. When Store is selected, a dialog box will appear for entering the point number and description.

Elevation Difference with Total Stations

Elevation Difference uses a dialog box that is very similar to the Point Store dialog. Under the Setup button, make sure that the occupied point, backsight and instrument height are set. Then have your rodman set the prism over the

The Store button will create a point at the current position. The default description will include the current cut/fill. When Store is selected, a dialog box will appear for entering the point number and description.

Elevation Difference with Total Stations

Elevation Difference uses a dialog box that is very similar to the Point Store dialog. Under the Setup button, make sure that the occupied point, backsight and instrument height are set. Then have your rodman set the prism over the
point you are interested in. Pick Read(F1) or Read & Store(F5) and the total station will take a shot.

After the shot is taken, the dialog box looks like the one at right. Carlson Field found the design elevation for this point (557.535) and compared it to the actual current elevation (530.0). Based on the current and design elevations, Carlson Field reports to how much cut or fill is required to get to design elevation. In this case, it is fill 27.535. The cut/fill also appears in the Desc box. If you click Store, Carlson Field will record this point and plot it on the drawing, including the Desc as a label.

<table>
<thead>
<tr>
<th>Setup (F3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu(F11)</td>
</tr>
<tr>
<td>H:123'00&quot;00&quot; V:90'00&quot;00&quot; SD:30.000</td>
</tr>
<tr>
<td>OC:1 BkAz:0.0000 HI:0.000</td>
</tr>
<tr>
<td>Point Number: 2</td>
</tr>
<tr>
<td>Rod Height: 0.000</td>
</tr>
<tr>
<td>Northing: 4983.661</td>
</tr>
<tr>
<td>Easting: 5025.160</td>
</tr>
<tr>
<td>Elevation: 530.000</td>
</tr>
<tr>
<td>Desc: FILL:27.535</td>
</tr>
<tr>
<td>Options (F6) Code (F7)</td>
</tr>
<tr>
<td>GRID:557.535</td>
</tr>
<tr>
<td>FILL:27.535</td>
</tr>
<tr>
<td>Read (F1) Store (F2)</td>
</tr>
<tr>
<td>Read &amp; Store (F5) Exit</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: DTM
Prerequisite: None
Keyboard Command: grd_gps

Prepare Story Stake

This command creates points with cut/fill information stored in the note fields for the points. Beginning at a point and facing a specified direction, the cut/fill information describes a design surface that is defined by contours and 3D polylines in the drawing. The program prompts you to pick the starting point followed by a direction point. Then the intersections for all the contours and 3D polylines between these two points are calculated and the resulting horizontal distances and slopes are shown in a dialog. In this dialog, you can edit, add or remove these slopes descriptions. The Point Description can also be specified. When OK is clicked, a point in the coordinate file is created at the starting point with this information stored in the note file. An offset point is also created at the specified offset distance back from the starting point. At the end of Prepare Story Stake, a report of all the created points and the corresponding cut/fill data is shown if the Create Report option was set. Prepare Story Stake does not draw the points in the drawing. These points can be drawn using the Draw-Locate Points command.

The cut/fill information in the note file can be used in the Stakeout routine. In Configure Field>Stakeout Settings there is an option to Display Point Notes in Stakeout Report. With this option active, the cut/fill data in the note file will be displayed when the point is staked out.

Prepare Story Stake is not a prerequisite for Story Stake By Points or Story Stake By Polyline. In fact, working in combination with Stakeout, Prepare Story Stake is an alternative to these other routines.
**Story Stake By Points**

This command creates a report of cut/fill slopes and distances of a design surface from a starting point. First you move to the starting point and then take a reading from the instrument to get the starting point coordinates. This starting position is shown in the drawing. Next you pick a point in the drawing to define the direction. The drawing should contain the design surface entities. The program will then calculate all the intersections with contours and 3D polylines between these two points. The resulting horizontal distances and slopes are shown in a report dialog. From this dialog, there is an option to stakeout one or two offset points set back from the starting point at the specified offsets.
Story Stake Along Polyline

This command creates a report of cut/fill slopes and distances of a line across a design surface. The line is defined as perpendicular from a polyline starting at a specified station and going a specified distance. The drawing should contain design surface entities. The program will calculate all the intersections with drawing contours and 3D polylines along the line. For example, the polyline could be a toe of slope and this routine would be used to create story stakes at an interval along this polyline.

The routine starts by selecting a 3D polyline from the drawing. Then there is a dialog to specify the settings. The Station is the distance along the polyline for the starting point of the story stake. The Next Interval is used to increment the station for the next default station. The Story Offset is the length of the story stake line from the starting point. To have the story stake line go perpendicular right from the polyline, enter a positive offset value. To go left, enter a negative offset. The Read Current Position button will take a measurement from the instrument to find the station of your current position. This current station is put in the Station field. The Pick Point button will prompt you to pick a point in the drawing view. The station of this point is used to fill out the Station field.

After specifying the stakeout station and story offset, then program runs the stakeout routine to guide you to that station on the polyline. When that point is staked, the program calculates the story stake and the resulting horizontal distances, cut/fill and slopes are shown in a report dialog. From this dialog, there is an option to stakeout one or two offset points set back from the starting point at the specified offsets.
Roads Menu

The Roads pull-down menu has commands for road stakeout and preparing the road design files. Most of these commands are described in the Civil Design manual.
Centerline Position

This function determines the station and offset relative to a centerline for a point. The centerline can be defined by a centerline file (.CL), a points, or by a polyline. The centerline file can be created with commands in the Roads menu. One advantage of centerline files is that it allows you to use profile files which can report cut/fills. For the points method, you can either give two points or a starting point and azimuth. The points can be defined by a point number from the current coordinate file or by simply entering the northing and easting. The first dialog for Centerline Position has the choice for centerline file or points method. With the centerline file option, the dialog shows the last centerline file name used. If this file is correct, then click OK. Otherwise use the Select button to choose the centerline file name.

Light bars are useful for left-right guidance. To enable the light bar option go to Configure Field, then to Centerline Position Settings and pick Use Light Bar.

Centerline Position with GPS

Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position. Carlson Field finds and displays in the dialog the station/offset for this point.
An arrow icon will appear on the drawing showing your location. You can move along the centerline and Carlson Field will report the station/offset in real-time. If you move beyond the ends of the centerline, then the program will stop reporting station/offset and instead will report "Off CL".

The Store button will create a point at the current position. The default description will include the current sta-
Centerline Position with Total Stations

Centerline Position uses a dialog box that is very similar to the Point Store dialog. Under the Setup button, make sure that the occupied point, backsight and instrument height are set. Then have your rodman set the prism over the point you are interested in. Pick Read(F1) or Read & Store(F5) and the total station will take a shot.

After the shot is taken, the dialog box looks like the one at right. Carlson Field reports the current coordinates and the station/offset. The station/offset also appears in the Desc box. If you click Store, Carlson Field will record this point and plot it on the drawing, including the Desc as a label.

Pulldown Menu Location: Roads
Prerequisite: None

Offset Stakeout

This function stakeouts a point at a given station and offset of a centerline and reports the cut or fill to a design elevation. The centerline and design elevation can be defined by four methods as set in the dialog show. The Design Files method uses a centerline file (.CL) for the horizontal alignment and a profile file (.PRO) for the vertical alignment. A template file (.TPL) for the design cross section is optional for the cross slope. Without a template file, the program will use the elevation of the profile along the centerline. A superelevation file (.SUP) and a template transition file are optional. These design files can be created with the routines in the Roads menu. The Section File method uses a centerline file for the horizontal alignment and a section file (.SCT) for the design elevation. The section file consists of cross sections of offset/elevation points for a series of stations. Section files can be used instead of the Design Files method when a road design is too complicated to model using design files. For example, if the road contains special ditches at various offsets and varying lane widths, then it may be easier to enter a final section file than to define the template and template transitions. The Points method uses two points to define both the horizontal alignment and design elevations. The design elevation is linearly interpolated between the points. The points to used are specified in the next dialog by entering point numbers from the current coordinate file or by directly entering the coordinates. The 3D Polyline method uses a 3D polyline for both the horizontal and vertical alignment. With this method, the program will prompt you to select the 3D polyline from the drawing. For both the Points and 3D Polyline methods, you can specify the starting station of the horizontal alignment. When using the Design Files and Section File methods, the horizontal alignment starting station comes from the centerline file.
Chapter 10. Field Module
After specifying the offset stakeout method, Carlson Field prompts for the station and offset to stakeout as shown in the dialog. The station should be entered as a number without the "+" symbol. The Next Interval field is used to increment the stakeout station for the next stakeout point. In addition to incrementing to the next interval, Carlson Field will also pick up special profile or centerline points between intervals. Centerline special points include: start point, end point, curve (PC, PT) and spiral (TS, SC, CS, ST). Profile special points include: start, end, vertical curve (VC, VT), high points and low points. For example, if the current station is 100 and the interval is 50 and there is a centerline PC at 112.4, then the next station after 100 will be 112.5 followed by 150. The Station List button brings up a list of all the station intervals and special stations. You can select a station to stakeout by selecting the station from the list and pressing OK.

There are two offsets to allow for separate offsets for the design elevation and stake location. The Side For Stakeout toggle selects between left and right offsets. The Design Offset is where the stake point elevation is calculated. The Stake Offset determines X,Y position of the stakeout point by finding this offset at the stakeout station along the horizontal alignment. Having Design and Stake offsets applies, for example, to staking the back of a curb, where the Design Offset is 12, but the stake offset is 17 (5' behind the back of curb, with the elevation reference to the actual back of curb design elevation). The Stake Offset can be specified either as an offset from the design point or as an offset from the centerline. There is also an optional vertical offset that applies to the elevation of the design point. With the Design Files and Section File methods, the vertical offset works as an offset from the template or cross section surface. For example, a vertical offset of -0.5 could be used to stakeout the bottom of a 0.5 subgrade. With the 3D Polyline and Points methods, the vertical offset adjusts the elevation from the along the centerline at the stakeout station.

The Read Current Position button will take a measurement from the GPS or total station to find the station of your current position. This current station is put in the Station field.

The Pick Point button will prompt you to pick a point in the drawing view. The station and offset of this point are used to fill out the Station and Offset fields.
After specifying the stakeout stations and offsets, Carlson Field uses the same stakeout function as used in the Stakeout command. This stakeout function guides you to the stakeout point and reports the cut/fill to the design elevation. You can store the stakeout point. When the stakeout is done, the station/offset dialog appears for staking the next point. Either enter the next station/offset or pick Exit to end Template Stakeout.

For total stations, you should run the Equipment Setup command before Template Stakeout to set the occupied point, backsight and instrument height.

Stakeout dialog for GPS
Stakeout dialog for total stations

Pulldown Menu Location: Roads
Prerequisite: None

Slope Staking

This command guides you to the catch point where the cut/fill slope intersects the existing ground. Coordinates from the GPS receiver or total station are used to model the existing ground. There are four methods for defining the cut/fill slopes:

- Design Files
- Section File
- User Entry
- 3D Polyline

Design files include a centerline file (.cl), profile file (.pro) and template file (.tpl). The centerline defines the horizontal alignment, the profile defines the vertical alignment and the template defines the cross slopes and cut/fill slopes. Superelevation (.sup) and template transitions (.tpt) files can also be used. Using the design files, any station along the centerline can be slope staked. These design files can be created with commands in the Roads menu.

Section files (.sct) can be used instead of design files when the road is too complicated to model using design files. For example, if the road contains special ditches at various offsets and varying lane widths, then it may be easier to enter a final section file than to define the template and template transitions. A section file consists of offset-elevation points at different stations. At a minimum, each station should contain the pivot point offset-elevations. The slope staking routine will start the cut/fill slope from the furthest offset point in the section.
For example, when staking the right side, the right most offset will be used as the pivot point. The section file can optionally contain additional offsets such as centerline and edge of pavement. The program can then report the horizontal and vertical distances from the catch point to these additional offsets. The section pivot offsets can also be assigned a description which the program reports before starting the slope staking. For example, a pivot offset could be “2:1 from flat bottom ditch” which is reported to the operator. When using section files, a centerline file is also required to establish the horizontal alignment. Any station along the centerline can be slope staked because the program will interpolate between entered section stations. The cut/fill slopes from the section can be either User-Entered or Continue Last Slope. The User-Entered option will use the cut/fill slope ratios as entered in the dialog. The Continue Last Slope option will use the last two points in the section file as the cut/fill slope. This Continue Last Slope option applies to section files that contain pivot point to ground segments whereas the User-Entered option is for section files that end at the pivot points.

User entry is a simple method for slope staking that only requires a centerline file. With this method, the program prompts for the cut/fill slopes and the pivot offset and elevation. The program finds this offset-elevation for the stake station along the centerline and begins the cut/fill slope from this point.

The 3D Polyline method uses a 3D polyline for both the horizontal and vertical alignments. The program will prompt you to select the 3D polyline from the drawing. There are two polyline methods. The Station Along Polyline method does slope staking perpendicular to the polyline like the other slope staking methods. The Endpoint Projection is a special method that slope stakes from the selected end of the polyline. This method is described at the end of this section.

The first dialog in Slope Staking chooses the design method. For Design Files method, the files are specified in this dialog. For the other methods, the cut and fill slope ratios are also defined in this dialog.

The next dialog sets the station to slope stake. The station should be entered as a number without the "+" symbol. For the 3D Polyline method, the starting station of the polyline is specified in the first dialog. For all the other methods, the starting station of the alignment is set in the centerline file. The Next Interval field is used to increment the stakeout station for the next stakeout point. The Read Current Position button will take a measurement from the GPS or total station to find the station of your current position. This current station is put in the Station field. The Pick Point button will prompt you to pick a point in the drawing view. The station of this point is used to fill out the Station field. For the User-Defined method, this dialog also contains the offset and elevation of the pivot point. For the 3D Polyline method, this dialog also contains the pivot point offset and vertical offset from the 3D polyline to
the pivot point.

For the design file method, the centerline elevation at the stakeout station is calculated using the design profile and then the template is applied to calculate the pivot point. For the section file method, the pivot offset is interpolated from the section file. For example, if the stakeout station is 75 with offset right and the section file has offset-elevation of 18.0 right, 100.0 elevation at station 50 and has 20 right, 102.0 elevation at station 100, then the pivot offset for station 75 would be 19.0 right, 101.0 elevation. For the user entry and 3D polyline methods, the pivot point is specified Station For Slope Stake dialog.

After the slope stake station and pivot point are specified, Carlson Field begins to read the GPS receiver or total station to get the current position. The existing surface to tie into is defined by the elevations from these current position coordinates. The point where the cut or fill slope from the pivot point intersects the existing ground is called the catch point. As each coordinate is read, an existing surface cross section is built and the catch point is calculated. Carlson Field will automatically determine whether to find the catch point on the right side or left side of the centerline depending on the side of your current position. The program displays, in real-time as you move, the northing-easting and station-offset-elevation of your current position and the offset of the catch point. The distance from the current position to the catch point is reported as the offset difference as either "IN" or "OUT". The OUT means you should move out from the centerline. The IN means that the catch point is closer to the centerline. Based on this offset difference, you move perpendicular to the centerline either towards or away from the centerline to reach a new offset from the centerline while maintaining approximately the same station. The difference between your current station and the stakeout station is reported as the "UP" or "DOWN” distance. The UP means that your
current station is less than the stakeout station and you should move up the centerline. Likewise, the DOWN means that your current station is greater than the stakeout station and you should move back down the centerline.

When the catch point is located, press the Store button to end the slope staking. A report dialog is then displayed. The Catch Pt is the actual station, offset and elevation of the target catch point. The Stake Pt is the as-staked station, offset and elevation of your current position. The dialog also reports the horizontal and vertical distances from the catch point to the pivot point and the other template points. The Store Catch Point option will record the as-staked coordinates of the catch point to the current coordinate file. The Stake Offset Point is an option to locate an offset point. The offset to stake can be entered as a distance from the catch point or as an offset from the centerline.

To locate the offset point, the same stakeout function from the Stakeout command is used. This function will guide you to the offset point. When the offset is reached, pick the Store button. Then an Offset Point Report dialog pops up containing the station, offset and elevation of the offset point and the horizontal distance, vertical distance and slopes from the offset point to the catch point, from the catch point to the pivot point and from the pivot point to the template points.

After locating the offset point, the station to stakeout dialog appears. You can enter the next station to stakeout or pick the Exit button to end Slope Staking.

**Endpoint Projection**
This is a special case of the 3D Polyline method that slope stakes from the end of the polyline. The program will prompt to pick a polyline and the end to stake from is the end nearest to the pick position. The direction of slope staking is in the direction of the polyline as if extending the polyline. The program prompts for the elevation of the pivot point which defaults to the elevation at the polyline endpoint. There is also an option to offset the pivot point along the polyline back from the endpoint.

After the pivot point is specified, the program starts the stakeout routine to guide you to the catch point. Then there is a report to show the difference between the staked and the calculated catch point.

**Pulldown Menu Location:** Roads  
**Prerequisite:** A centerline file or 3D polyline

### Slope Inspector

This command reports the azimuth, distance and slope between your current position and a starting point. The command starts by prompting you to move to the starting point and take a reading. This sets the starting point.

#### Slope Inspector with GPS

Carlson Field will continually read your current position from the GPS receiver. A dialog box appears displaying your current position and the azimuth, distance and slope from the starting point to your current position. An arrow icon will appear on the drawing showing your location. Pick the New Start button to set a new starting point.

#### Slope Inspector with Total Stations

Before running Slope Inspector, make sure that the occupied point, backsight and instrument height are set correctly in the Equipment Setup command. Then start Slope Inspector and read a measurement for the starting point. A dialog box appears displaying your current position. Pick the Read button to take another measurement. Carlson Field will calculate the new point and report the azimuth, distance and slope from the starting point to the new point. An arrow icon will appear on the drawing showing your location. Pick the New Start button to set a new starting point.
GIS Menu

The GIS menu commands for Field are described in the GIS manual.

Equipment Menu

Apache Lightbar

Carlson Field can use an external Light Bar for determining elevation differences and centerline offsets.
Light Bars can indicate whether your current position is in cut, fill or on-grade when set vertically. When set horizontally, Light Bars can give centerline left/right offsets. Currently Carlson Field supports a light bar made by Apache, as well as by Mikrofyn, that has arrows for up/down, or left/right, and a row of lights for on-grade. The Light Bar must be connected to a separate serial port than the GPS.

CSI GBX Pro

**Hardware Setup**

1. Connect the receiver to the antenna by coaxial antenna cable if it is not already connected, and ensure that that the receiver has ample power.

2. Ensure that the antenna is tracking corrections from an MSK Radio Beacon. The easiest way to do this is to use the antenna’s automatic frequency scanning when first powering on the receiver

   a) To do this, enter the [SETUP] menu, and select the option [AUTO BX SEARCH]

   Note: The beacon automatically selected by this scan will be saved to the receiver's memory and used automatically in the future, until either the scan is executed again, or until a new beacon is specified manually. Thus, it is not necessary to scan each time the beacon is used, provided it is still operating in the same general area.

   b) A scan can be performed again in the event that the beacon is lost to scan for the next nearest beacon.

3. Enter the [Setup] menu, then select [Options] then [NMEA ON/OFF]. This menu allows the enabling or disabling of various NMEA messages. The only ones which are necessary are the GGA, GSV and GSA messages. All others should be disabled.

**Software Setup**

4. In Carlson Field, no further setup is necessary to make use of the CSI GBX Pro. Simply use the other Carlson Field functions as normal. Note however, that the elevations reported by the CSI GBX Pro are MSL (Mean Sea Level).
Depth Sounder

Carlson Field data collection can be used in conjunction with a depth sounder to survey the beds of rivers and lakes. Carlson Field takes input from both a GPS receiver and a depth sounder to determine and record the elevation of the terrain directly below the surveying boat or barge.

All of Carlson Field's routines work with the depth sounder to let you collect points on the underwater terrain. The elevation stored for each point is the elevation of the bed. Modeling of the bed surface works as easily as modeling any surface using Carlson Software. Carlson Field can be a powerful tool for marine surveying and construction.

Settings

To modify the Field depth sounder settings, go to the Field menu and select Configure Field. Choose the Depth Sounder Settings button.

The Depth Sounder Settings menu appears. At this point, Hydrotrac by Odom is the only equipment-specific depth sounder interface. Carlson Field works with other depth sounders that have NMEA standard interface. If you want to use Carlson Field without the depth sounder, make sure the Model is set to None.

For the Hydrotrac model, the depth sounder should be set so it outputs message DESO25 I/O. This is done using the Hydrotrac software. Odom should be contacted with any problems involving setting this message (www.odomhydrographic.com or 225-769-3051). The draft setting on the Hydrotac should also be set. This will account for the height difference between the water surface and the working sensor of the Hydrotac.

On the next line appears a box labeled Store Depth in Notes. Carlson Field saves point data in a coordinate file and in a text note file. By checking this box, the note file will record the water depth at each reading along with the other information about that point. (Settings to control the rest of the information saved in this file can be found in the menu Configure Field >Point Settings.)

The window labeled Debug should be set to zero for normal use.

The row of buttons labeled Serial COM Port refer to the COM port on your computer where the depth sounder is plugged in. Carlson Field requires two serial points on the computer when working with a depth sounder (one for the GPS and the other for the depth sounder). The depth sounder serial port must be separate from the GPS serial point.

Starting Out

Before working with the depth sounder, we suggest that you make sure the GPS system is working properly with Carlson Field. De-activate the depth sounder by setting the Model to None in the Depth Sounder Settings dialog box. Set up the GPS system that you are using and plug the rover receiver into the COM port for the GPS. Go to Monitor GPS Position under the Field menu. Check that the information being output is correct: Are the latitude and longitude readings what they should be? Are the north and east coordinates aligned to your job coordinate grid? Are the HRMS and VRMS low enough (less than one)? Is the status fixed? If it's autonomous or float, this rover...
could be having trouble receiving the radio corrections the base receiver should be broadcasting. If everything is working properly, exit the monitor screen and start the depth sounder setup.

Measure the vertical distance from the GPS antenna to the surface of the water. This distance will be called the rod height. Go to the Configure Field > General Settings window and enter this measurement in the Rod Height box.

Plug the depth sounder into the depth sounder COM port on your computer. Go to the Configure Field > Depth Sounder Settings window and set the depth sounder Model. Set the rest of these settings as you want them and click OK.

Go back to Monitor GPS Position. Everything should appear as before, except there should be a new entry called Depth and Elevation should have changed to Bottom Elv. The correct depth should be showing and the Bottom Elv should be showing the elevation of the bed.

The usual Carlson Field functions will all work with the depth sounder active. The windows for Monitor, Point Store and Auto Points at Interval will display the depth when the depth sounder is set as active.

**Geodimeter**

**Geodimeter 600 For Remote Mode**

*Note:* Firmware version 696-03.xx or higher is required on the instrument. To check the version, pick MNU-5-4-1.

**SET-UP**

1. Connect the instrument to the battery pack. There is no need to connect the keyboard to the battery if it is going to be turned off, or attached to the unit.
2. Connect the prism to the top port of GeoRadio.
3. Connect the bottom port of the GeoRadio to Carlson Field. Then turn on the radio.
4. Turn on the Geodimeter. The Geodimeter starts with the screen for leveling the instrument. When the instrument is leveled press [ENT] key to continue to the next step. Now the instrument starts compensator calibration. You can wait for calibration to finish or turn it off. To turn calibration off press on [F] 22, enter 0 for comp. This needs to be done when the instrument is turned on and before [ENT] is pressed.
5. Next Geodimeter will ask for different values for pressure, offset, etc. They can either be left like they are by pressing on [ENT] or they can be changed.
6. Press [F] 79, it is the End of Transfer character, which should be set to 4.
7. To set radio, and station channels, press [MNU], and enter 1 for "Set". After set press 5, which will give the user opportunity to change channel, station, and remote address.

*Note:* The channel, station and remote address on the Geodimeter should match the channel, station and remote address in Carlson Field.

8. To set the Geodimeter for remote mode, press on RPU, then 3 for remote and 1 for ok, you can answer [NO] to Define Window? If [ENT] is pressed, the instrument will ask "Aim to A Press Ent", for which the user have aim to upper/lower left boundary and press [ENT], for "Aim to B Press Ent", aim to the upper/lower right boundary and press [ENT]. For "Measure ref obj?" press [ENT] if you want a reference object, otherwise press [NO]. Than the instrument is going to say remove keyboard however the keyboard can stay on.
9. After Geodimeter display screen turns itself off, it's ready for Carlson Field.

**CARLSON FIELD**

1. In Configure Field, under equipment type there should be Geodimeter. In Communication Settings Baud Rate should be set to 9600.
2. After Configure Field go to Equipment Setup and make sure GeoRadio is checked, and the channel, station and remote address is the same as it is in the total station.

*Note:* We recommend using channel 3.

3. If calibration box is checked the instrument will calibrate, to turn of calibration the box should be unmarked.
4. In setup there is also an option to turn on/off-tracking lights.

**Geodimeter 600 For Direct Connection**
1. Connect the instrument to the battery pack, and the control unit to Carlson Field.
2. Under Field go to Configure Field and place Geodimeter in Equipment type.
3. Click on General Settings make sure that the baud rate is set to 9600.
4. Exit Configure Field.
5. Go to Equipment Setup and check Connect to Station and click OK.

Now you are ready.

**InnerSpace Tech depth sounder**

The communication settings for the InnerSpace Tech depth sounder are 9600-N-8-1.

**Laser Atlanta**

To setup Laser Atlanta select Menu on the instrument, then Serial, and set Baud rate to the same as Carlson Field's and Format to Laser Atlanta.
Leica Disto
The communication settings for the Leica Disto are 9600-E-7-1.

Leica GPS System 500
Setting Up a 500 Series Receiver
1. Connect the antenna cable to the ANT Port on the front of the receiver, and to the antenna.
2. If you are using the PacCrest radio module, screw it in place over Port 1 on the receiver and attach its antenna cable. Otherwise, connect any radio being used to Port 1, 2 or 3.
3. If an external power source is being used, be sure to plug it into the PWR Port on the front of the receiver.
4. If external power is not being used, ensure that there are batteries in one or both of the batter slots on the bottom of the receiver.
5. Plug the 9 pin serial connection cable into the serial port of the computer running Carlson Field and into the Terminal Port on the front of the receiver.

Configuring Carlson Field for Use With a 500 Series Receiver
1. Select "Configure Field" from the Field pull-down menu. This will open a new window with several buttons on it, as well as a pulldown list labeled "Equipment Type." Select "Leica 500 Series" in the Equipment Type menu, then select "Communication Settings."
2. Ensure that the COM port is set to the one that the serial cable is plugged into, and that the Baud Rate is 9600, the Char Length 8, the Stop Bits 1, and the Parity None. Close this menu and the Configure Field menu.
3. In the Field pull-down menu, select "Equipment Setup." This will open another menu with several selectable options and several buttons.
4. Use the radio buttons on the top right to select whether the receiver will be a rover or a base station. Also be sure to select the antenna types being used from the pulldown menu at left.
5. Enter the desired Satellite Elevation Cutoff in the text box above the column of buttons. All satellites with elevations less than this number will not be used in position calculation(receiver default is 15).
6. Select the "Radio Settings" button. This will open another window with several selectable settings. Select the Port number the radio is attached to on the front of the receiver, the baud rate of the radio, number of radio stop bits and radio parity. These last three settings should be listed in the documentation for the radio being used. Also, select the desired format to use for sending and receiving messages from the bottommost option. Exit this menu.
7. If the GPS receiver is being configured as a base station, select the "Configure Base Station" button from the Equipment Setup menu, and proceed with step 8. Otherwise, the receiver is ready for use.
8. There will now be a menu with a few buttons to select a method of determining the base station's present location. The options are:

Read From GPS- Read one or more position readings from the GPS and use this position or the average of several positions for the base station corrections.

Enter Lat/Lon- This option will bring up a menu to enter the exact Latitude, Longitude, and elevation of the receiver's position by hand.

Enter State Plane Coord- This option will bring up a menu to enter the coordinates of the position of the base station according to the state plane coordinate system.

Read from File- This option will read a coordinate set from a file already saved to the computer.

Select whichever method will be used, and enter any necessary data. The receiver is now configured and ready for use.

Other Buttons In the Setup Menu:

1. Power Cycle Receiver will shut the receiver down and then power it up again. Used to clear the receiver's memory.

2. Power off Receiver shuts the receiver down. Note that if this button is pressed, any settings changes made while in this menu will not be saved to the receiver.

3. Send command to receiver allows for sending messages to the receiver. The user must enter the message by hand. This feature is only intended for use in conjunction with the technical support provided with Carlson Field.

Troubleshooting the Leica 500 Series in Carlson Field

Several possible errors can occur in the course of using a 500 Series Leica receiver with Carlson Field. Carlson Field will use all its standard error messages to report usual types of error messages, such as an inability to communicate with the satellites that are being tracked. In addition, the Leica 500 Series of receivers will have their own set of error messages unique to themselves. This type of error message is reported if there is an error during the transmission of various configuration messages to the receiver to set up the base station settings. Such messages will say "Set Port Message Rejected", or "Set Base Antenna Message Rejected" or "Set Antenna Height Message Rejected" or "Set RTK Message Rejected." Each indicates which particular facet of the configuration failed. If one of these messages is rejected, it is likely a momentary transmission error. If, on the other hand, several (or all) are rejected, it is possible there is a problem in the communication line between the computer and the receiver, which should be checked.

Leica TC Series

Leica TC Series Instrument Setup

On the instrument, make sure that the communication settings have CR/LF for the terminator.

Remote Mode

1. Turn on Leica

2. Connect Leica to rover radio, and connect the radio to the larger battery.

3. Connect the base radio to Carlson Field, and the smaller battery.

4. In the Field menu go to Configure Field, and under equipment type put Leica TC

5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check if the baud rate is 19200. When Leica is turned on under Main Menu enter 5 for "Configuration", and 2 for "Communication Mode", then enter 1 for "Gsi parameters", and check if the baud rate is also set 19200.

6. Line Terminator in "Gsi parameters" should be set to CR/LF


8. When back in Communication Mode screen enter 5 for "RCS (Remote) ON/OFF" and make sure it's NOT set for remote mode.

10. In the Field menu go to Equipment Setup and for Connection Mode check remote.
11. When done click on OK.

To put Leica in Tracking: On Gun press "FNC" then ATR+ and LOCK+

**TCA 1800**

1. Turn on Leica
2. Connect Leica to Carlson Field
3. In Field go to Configure Field, and under equipment type put Leica TC
4. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. When Leica is turned on press [F3] for "conf", then enter 3. The baud rate can be changed by pressing [F6] for "list", when done enter [CONT]. In addition to baud rate parity, char length, and stop bits should also match.

Note: Default in Carlson Field is not the same as default in Leica.

**Leica 1100**

To set up the Leica 1100 total station select the following commands on the instrument: Main Menu > Configuration > communication mode > GSI parameters. In the GSI parameters command copy the following settings: (baud=to Carlson Field's, protocol=GSI, parity=to Carlson Field's, Terminator=CR/LF, Data Bits=to Carlson Field's, Stop Bit=1), Geocom Param (baud=Field's) RCS Param (baud=Field's). Also, make sure RCS mode is OFF.

**Leica 700**

To set communication settings for Leica 705s, go Shift key then Prog (Menu) key and then to All Settings and last to PC Comm.
**Manual Total Station**

This method allows you to run Carlson Field in total station mode without being connected to equipment. The program will prompt you to enter the horizontal angle, zenith angle and slope distance. This method can be used for demonstration purposes or to work with total stations that cannot connect to Carlson Field. For these total stations, instead of the automatic connection, you can take a shot, read the instrument and then manually enter the data into Carlson Field.

As with other total stations, the first step is to run Equipment Setup to establish the occupied point, backsight and instrument/rod heights before running Carlson Field functions. Then in Carlson Field functions, when you pick the Read button, the program will bring up a dialog for entering the angles and distance. The angles should be entered in dd.mmss format (degrees.minutes.seconds).

![Manual Read](image)

**Mikrofyn Lightbar**

Carlson Field can use an external Light Bar for determining elevation differences and centerline offsets. Light Bars can indicate whether your current position is in cut, fill or on-grade when set vertically. When set horizontally, Light Bars can give centerline left/right offsets. Currently Carlson Field supports a light bar made by Mikrofyn named RD-4 1137551, as well as by Apache, that has arrows for up/down, or left/right, and a row of lights for on-grade. The Light Bar must be connected to a separate serial port than the GPS.

![Mikrofyn Lightbar](image)

**Navcom Configuration Guide**

This guide will walk you through the setup process for your Navcom units. It covers individual unit setup as well as base/rover setup under the simplest possible configuration. If you want to customize the configuration, consult the reference manual.

A) Preliminary setup steps

Perform the following preliminary steps to initialize your computer for communication with your Navcom units:
1) Startup the Carlson product you intend to use.
2) Select CONFIGURE FIELD, from the FIELD Menu.
3) Select NAVCOM from the EQUIPMENT TYPE dropdown
4) Click the COMMUNICATION SETTINGS button. Verify that the SERIAL COM PORT is set to the port you intend to use to communicate with your Navcom unit. (usually COM1).
5) In the COM PORT SETTINGS box, click DEFAULT, and verify that baud rate=19200, parity=NONE, char length=8, and stop bits=1.
6) Click OK, and then click the GPS SETTINGS button.
7) Under GPS SETTINGS, set your HRMS and VRMS tolerance. For single-unit setup, these numbers should be at least 10. For base/rover configuration, they should be around 0.01.
8) Under PROJECTION TYPE, select the coordinate plane you wish to use. For state plane, make sure you choose the proper ZONE.
9) Click OK and then click EXIT

**B) Single-unit setup (no corrections)**

Before attempting a multi-unit setup, it is recommended that you first try setting up your Navcom unit to output an uncorrected position. The steps to do so are explained here:

1) Mount your GPS Antenna on a tripod in a place where its view of the sky is not obstructed.
2) If your antenna is separate from your receiver, connect your antenna to your receiver's AN TENNA port. (This step can be skipped for the RT-3010S, and other all-in-one models)
3) Plug your receiver into a power supply, or insert fully charged batteries into the battery ports. (Not all units have battery ports).
4) Turn your receiver on by holding down the power button for a few seconds, or until the status lights flash on.
5) Use the serial port cable to connect your computer to port A of your Navcom unit. Make sure the port on your computer that you use corresponds to the one you chose during preliminary setup.
6) Under the FIELD menu, choose EQUIPMENT SETUP.
7) If a PORT SETUP window pops up, set CONTROL PORT to PORT A, and RTK DATA PORT to RADIO PORT.
8) Setup is now complete. Steps that follow are optional.
9) Click the NAVIGATION STATUS button. From here you can monitor the progress of your Navcom unit as it calculates its position. Click AUTOREFRESH to view continuously updated status reports.
10) It may take a few minutes for the unit to calculate its position, if the unit was reset, or recently turned on. When the calculation is complete, VALID NAVIGATION will read YES. When this occurs, the Navcom unit is ready for use. Click CLOSE, then click CANCEL WITHOUT SAVING.
11) To monitor your position, choose MONITOR GPS POSITION from the FIELD menu, and you will see your current position. All Carlson Field GPS functions should now work.

**C) Multi-unit setup (using corrections from a base)**

1) Base Setup
   a) Perform the preliminary and single-unit setup steps described above.
   b) Attach the radio antenna to the radio port of your base unit.
   c) Select EQUIPMENT SETUP from the FIELD menu.
   d) Select a CORRECTION TYPE. We recommend NCT RTK.
   e) CLICK the CONFIGURE BASE button.
   f) When prompted to enter a position, enter the exact position of the base unit. Note that the accuracy of your rover's calculation depends on this position being completely accurate.
   g) Enter a station ID of 0. The station ID is only used in RTCM mode.
   h) Verify that STATION TYPE now reads BASE.
   i) Base station setup is complete. Click SAVE SETTINGS AND EXIT.

2) Switch the device you're plugged in to:

   After configuring the base, unplug your serial cable from your base's port A, and plug it into your rover's port A. Note: Whenever you switch the device you're plugged into be sure to close the Equipment Setup window first.

3) Rover Setup
a) Perform the preliminary and single-unit setup steps described above.
b) Attach the radio antenna to the radio port of your rover unit.
c) Select EQUIPMENT SETUP from the FIELD menu.
d) Select a CORRECTION TYPE. We recommend NCT RTK. Note that this selection must match the selection made during base setup.
e) CLICK the CONFIGURE ROVER button.
f) Verify that STATION TYPE now reads ROVER.
g) Rover setup is complete. Steps that follow are optional.
h) You can verify that the rover is receiving correction by clicking the MONITOR INCOMING CONNECTION, and then clicking AUTOREFRESH. The open window shows the time since each correction type was last received (delta time). In NCT RTK mode, the delta time of 5b, should stay around 1 second, and the delta time of message 5c should not go above 30 seconds. If these numbers are high, or if they read NEVER, try repeating the setup process or calling Carlson Software technical support.
i) Click SAVE SETTINGS AND EXIT, and then choose MONITOR GPS POSITION from the FIELD menu. The STATUS display should eventually go to LOCK.

Troubleshooting Base/Rover Configuration:

If you've configured a base to output corrections, and you're rover does not appear to be receiving the corrections, try each of the following in order:

1) Verify that your BASE and ROVER are both set to the same correction type.
2) Under Configure Radio, check that your ROVER is set to slave, and that your BASE is set to master.
3) Under Configure Ports, check that both your base and your rover's RTK Data Ports are set to the proper value (Usually Radio Port).
4) Under the Edit Base Position, check that your BASE is set to a valid position. Note that if the given position is too far away from the position the BASE is reading, the BASE will not send corrections.
5) If you're trying to use RTCM, make sure the BASE and ROVER have the same station ID's.
6) Try increase the RTK Max Age constraint.
7) Under Navigation Status, verify that the Navigation is valid on both units. If either unit does not have a valid position solution, correction will not work.
8) Under Monitor Corrections, verify that the corrections you're using are arriving regularly. If they aren't you may need to reset both units.
9) Try configuring the BASE and ROVER again.
10) If all else fails, Soft Reset both units through the Reset Unit menu. After doing so, you will have to reconfigure the port settings of each device through the Configure Ports menu, and wait a few minutes for the devices to recalculate their position.
11) If none of these steps work, contact Carlson Software Technical Support.

Navcom GPS Setup

Carlson Field supports Navcom's NCT-2000D GPS message protocol, firmware versions 2.6 and later. If your Navcom unit has an earlier firmware version, contact Navcom for a free upgrade. Carlson Field has been tested extensively with Navcom models RT-3010S and RT-3020M.

From the Navcom GPS setup menu, or any of its submenus, the current device settings can be obtained by clicking the Retrieve Settings button. New settings can be saved by clicking the Save Settings or the Save Settings and Exit button. To cancel your changes, click Cancel without Saving.

By changing the SV Elevation Mask, you can prevent the Navcom Unit from using any satellite below a specified elevation angle (Range: 0-90).

By changing the PDOP Mask, you can prevent the Navcom Unit from using any GPS solution with a PDOP above a specified value (Range: 1-25).

By changing the RTK Max Age, you can prevent the Navcom Unit from using any RTK corrections older than a specified number of seconds. (Range: 0-1275, Multiple of 5).
By changing the *Base Station ID* on a base, you can provide your base with a unique identifying number so that rovers can specify which base they want to use for corrections. By changing this setting on a rover, you can specify which base unit you want to use. If 0 is specified, the rover will use any base station it can find. The base station ID only applies when using the RTCM correction format. (Range: 1-1023)

You can choose between 4 different *Correction Types*: NCT (Navcom Proprietary), CMR (Trimble's format), RTCM RTK (Messages 18-22), or RTCM DGPS (Message 1 and 9). When configured to BASE, changing the correction type changes the type being sent. When configured to ROVER, changing the correction type changes the type the unit is listening for. A ROVER will ignore all incoming correction messages except those of the type specified.

**Configure Ports Submenu:**

The *Control Port* should be configured to *Port A* or *Port B*, depending on which of the Navcom units' ports you are plugged into. Note that the *Control Port* refers to the number of the port on the Navcom unit, NOT the number of the COM port on your computer. If the *Control Port* is configured improperly, you will not be able to communicate with your Navcom unit.

The *RTK Data Port* refers to the device port out of which RTK corrections will be sent. This value should be set to *Radio Port*, unless you want to set up a non-wireless Base/Rover connection through Port A or Port B. The *RTK Data Port* cannot be the same as the *Control Port*.

**Configure Radio Submenu:**

The *Radio ID* is the value used to identify a unit on a wireless network of Navcom units. Make sure that no other Navcom unit in your vicinity shares the same *Radio ID*. By default, the *Radio ID* is the same as your Navcom unit's serial number. This value can be changed, although there isn't usually any need to do so.

The *Local Radio Type* can be set to either *Master* or *Slave*. Radio communication will only work between *Masters* and *Slaves*. Only one unit on your network should be set to *Master*. It makes sense to make the base unit a *Master*, and all rovers *Slaves*. These settings will be handled automatically by the *Configure Base* and *Configure Rover* routines. So there generally isn't any reason to set the *Local Radio Type* manually.

The *Local Antenna Power Level* allows you to configure your radio to use more or less power. The less power the radio has, the less it will be able to communicate over longer distances. It may be useful to change the power level if you're rover is not traveling far from your base, and you're trying to conserve battery power.

Within the *Navcom Radio Setup* menu, you will be able to access the following status information for all visible Navcom units on the network:

- **External Power**: Indicates whether the unit is plugged into an external power source (On or Off).
- **Battery A**: Indicates whether a well charged battery is plugged into Battery Port A (On/Good or Off/Low)
- **Battery B**: Indicates whether a well charged battery is plugged into Battery Port B (On/Good or Off/Low)
- **Status**: Indicates whether the unit is sending out corrections. (BASE or ROVER)

If more than two units are present, you can access this information for the additional units by selecting the desired unit's radio ID from the *Remote Radio ID* dropdown menu.

**Configure RTCM Submenu:**

Note: To access this menu, first configure the unit as a *BASE* and set the *Correction Type* to either *RTCM RTK* or *RTCM DGPS*.

Choose *message 18/19* to make your RTCM RTK base broadcast RTCM message types 18/19.
Choose *message 20/21* to make your RTCM RTK base broadcast RTCM message types 20/21.
Choose message 1 to make your RTCM DGPS base broadcast RTCM message type 1.
Choose message 9 to make your RTCM DGPS base broadcast RTCM message type 9

**Edit Base Position Submenu:**

Note: To access this menu, first configure the unit as a *BASE*. 
If your BASE already has a GPS position set, it will be shown here. (If you don't see it, try pressing Retrieve.) To edit this value, change the displayed number and press the Lock button. Click Survey to read a new GPS position from the Navcom unit. Click Empty, to clear the GPS position from the unit.

Reset Unit Submenu:
Click Soft Reset to send a reset command to the Navcom unit. If the command is successful, all three status lights on the unit should go solid temporarily. After performing a soft reset, you will have to go to the Configure Port Submenu to reconfigure the control port.

Click Factory Reset to send an emergency reset command to the Navcom unit. However, in nearly all cases, it is only necessary to use the Soft Reset button. After performing a factory reset, you will have to go to the Configure Port Submenu to reconfigure the control port.

View Firmware Submenu:
This submenu displays the Navcom firmware version your unit is using, along with the hardware serial numbers and the hardware model name.

Navigation Status Submenu:
If Valid Navigation reads Yes, your unit has successfully solved its position. If it reads No, the unit's position has not yet been calculated, and an error message explaining why will be displayed in the Error field. A rover will not try to use RTK corrections unless its navigation is valid. Similarly, a base will not broadcast correction unless its navigation is valid.

Navigation Status will read AUTONOMOUS if it is not receiving the type of corrections it has been configured to use. It will read FLOAT if it is receiving the right kind of corrections, but hasn't finished using them to calculate its position. It will read LOCK when it is receiving corrections and has successfully used them to calculate its position.

Navigation Mode displays the specific type of correction that is currently being used.

# of Satellites Used shows the number of satellites the unit is able to use in its solution. All DOP values are also shown here (GDOP, PDOP, HDOP, VDOP, and TDOP).

Click Refresh to load the latest values from the device.

Monitor Incoming Corrections Submenu:
Note: To access this menu, the local unit must be configured as a ROVER.
This menu displays the number of seconds since the arrival of each RTK correction type. At the top, the correction type currently being used is displayed.

In NCT Correction Mode, the relevant messages are 5B (correction), which should be arriving every second, and 5C (base position), which should be arriving every 16 seconds.

In CMR Correction Mode, the relevant messages are cmr0 (correction), which should be arriving every second, and cmr1 (base position), which should be arriving every 30 seconds.

In RTCM RTK Correction Mode, the relevant messages are RTCM message 22, and either messages 18 and 19, or messages 20 and 21, depending on your base's RTCM setup. Messages 18-21 should be arriving every second. Message 22 should be arriving every 6 seconds.

In RTCM DGPS Correction Mode, the age of correction messages (1 and 9) cannot be monitored here.

Click Refresh to load the latest values from the device.

Configure Base Submenu:
Before clicking Configure Base, first choose the type of corrections you want to use. When you click Configure Base, all steps necessary to configuring a base will be performed. You will be prompted for a Base Position and a Radio ID. Upon completion, the unit status should read BASE. If it does not, or if an error occurs during base configuration, try again, or consult the Base/Rover configuration troubleshooting section below.
Before clicking Configure Rover, first choose the type of corrections you want to use. When you click Configure Rover, all steps necessary to configuring a base will be performed. Upon completion, the unit status should read ROVER. If it does not, or if an error occurs during rover configuration, try again, or consult the Base/Rover configuration troubleshooting section below.

Switching the device you're plugged in to:

Whenever you switch the device you're plugged into be sure to either close the Equipment Setup window, or click Retrieve Settings from the top level Equipment Setup menu.

Troubleshooting Invalid Navigations:

If the Navigation Status menu reports an invalid navigation, your unit has not yet been able to calculate it's position. The unit may need more time, if less than 4 satellites are visible, or an error is reported. If you can't get a valid solution for a few minutes, try raising the PDOP mask, or lowering the Satellite elevation mask.

Troubleshooting Base/Rover Configuration: If you've configured a base to output corrections, and your rover does not appear to be receiving the corrections, try each of the following in order:

1. Verify that your BASE and ROVER are both set to the same correction type.
2. Under Configure Radio, check that your ROVER is set to slave, and that your BASE is set to master.
3. Under Configure Ports, check that both your base and your rover's RTK Data Ports are set to the proper value (Usually Radio Port).
4. Under the Edit Base Position, check that your BASE is set to a valid position. Note that if the given position is too far away from the position the BASE is reading, the BASE will not send corrections.
5. If you're trying to use RTCM, make sure the BASE and ROVER have the same station IDs.
6. Try increase the RTK Max Age constraint.
7. Under Navigation Status, verify that the Navigation is valid on both units. If either unit does not have a valid position solution, correction wills not work.
8. Under Monitor Corrections, verify that the corrections you're using are arriving regularly. If they aren't you may need to reset both units.
9. Try configuring the BASE and ROVER again.
10. If all else fails, Soft Reset both units through the Reset Unit menu. After doing so, you will have to reconfigure the port settings of each device through the Configure Ports menu, and wait a few minutes for the devices to recalculate their position.
11. If none of these steps work, contact Carlson Software Technical Support.

Troubleshooting when you cannot establish communication with the unit:

If all of your commands in the Equipment Setup menu are failing, try opening the Configure Ports submenu, selecting the proper Control Port, and saving the new settings. Make sure that you're plugged into the port you have chosen to be the control port.

If this does not work, issue a soft reset command. If this fails, try a factory reset command. If even this fails, call Carlson Software Technical Support.

Nikon Total Stations

Nikon A-Series

Nikon A-Series includes the A5LG/A5, A10LG/A10 and A20LG/A20. Also the C-100 and D-50 have the same communication as the A-Series and should be used in the SET mode.

Nikon 500 Setup

1. Turn on Nikon
2. Turn it Horizontally and Vertically to set it.

3. Connect Nikon to Carlson Field

Note: 9-pin serial cable from Nikon to Carlson Field should be NGT type and not SOKTOP.

4. In Field go to Configure Field, and under equipment type put Nikon 300,400,500 series.

5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. On Nikon press [MENU], then 3 for "sett", and 6 for "comm". The baud rate can be changed using the arrow keys.

6. Exit the Configure Field menu.

7. To check if units (Ft /M) matches for correct results, in Carlson Field under Settings go to Drawing Setup and select the appropriate button. On Nikon, press [MENU] and 3 for "sett" again, but now press 5 for "unit".

---

**Nikon 310**

Set the same baud rate in the Nikon 310 station as you did in Carlson Field and set the Nikon instrument to the record format by selecting on the instrument Fnc->5(Set)->6(other)->3rd screen.

**OmniStar Otto**

In Field go to Configure Field and under equipment type select CSI GBX/OmniStar Otto and in Communication Settings set the baud rate to 9600.

**Simulation GPS**

Simulation GPS mode is for demonstration purposes to show or practice Carlson Field functions. This mode allows you to run Carlson Field without being hooked up to any equipment. The program will automatically generate a position. This position is the first point in the alignment. If there is no alignment, then the starting point is 5000,5000,1000. There are keyboard commands to control the simulation position during continuous read commands such as Stakeout and Track Position.

Here are the keyboard commands:
1. Make sure that the Radian IS has fully charged batteries installed, as described in the receiver documentation.

2. Connect the Radian IS serial cable to "COM1" on the Radian IS, plugging the other end into the controlling computer's serial port.

3. If the Radian IS is to be used as a base, connect a PDL base radio to the "COM2" port of the receiver. If the IS is to be used as a rover, connect a PDL rover radio to the "COM2" port if the receiver.

4. Power the Radian IS on with its external power switch.

5. Once the receiver finishes its self-initialization (when all the lights on the side panel go out and then the battery light lights in just one position), it is ready for use with Carlson Field. However, positions will not be able to be logged until the receiver has acquired a few satellites. The receiver has enough satellites when the center light is at the second or higher level (when it is orange instead of red).

Software Setup

6. To configure the IS for use, select "Equipment Setup" from the Field pulldown menu. This will open a menu with several options:

a) Radio Baud Rate: This radio button sets the baud rate for COM2, the radio COM port. Make sure this number and the number the PDL's are set for is the same.

b) Station Type: This sets whether the Radian IS is to be configured as a base station or a rover.

c) Elevation Type: This allows selection of Geoid (MSL) or Ellipsoidal measures for height/altitude.

d) RTK Dynamics: This sets the dynamics mode of the receiver. In general, this setting should be set to "Dynamic/Kinematic".

e) Message Type: This sets what format of corrections this receiver will send/receive for RTK.

f) Motion Dynamics: This is used to set the receiver's calculations appropriate to the motion of the receiver.

g) Elevation Mask: This is the satellite elevation cutoff. No satellites with elevation less than this number will be used in corrections. This allows filtering out of satellites close to the horizon, which provide less accurate calculations for positions.

h) Send Command to Receiver: This allows a specific user-entered command to be sent to the receiver. Mostly used for troubleshooting with Technical support.

i) Configure Base: This configures the parameters of a base station for the receiver (Ex: Current position, etc.)

j) Power Cycle Receiver: This powers the receiver down and then turns it back on, clearing the main memory.

k) Save and Exit: This saves all settings changes and exit this menu.

l) Cancel: This restores original settings and exit this menu.

To set the Radian IS up as a Rover:

7. Select "Rover" for Station Type, and set the Radio Baud to match the PDL's which are being used. Also, set "RTK Dynamics" to "Dynamic/Kinematic", and set Motion Dynamics to the appropriate option.

8. Select "Exit and Save". The receiver is now ready for use as a rover.

To set the Radian IS up as a Base:
9. Select "Base" for station type, and set the Radio Baud to match the PDL's which are being used.

For most jobs, set RTK Dynamics to "Dynamic/Kinematic" (unless you are sure that static is more appropriate—even small fluctuations from wind on the pole can cause problems in Static mode). Set motion dynamics to Foot/Walking, and then select "Configure Base Station"

10. In the menu dialog that opens, there are a few buttons:

   a) Read from GPS: Read a position from the GPS and fix to that position
   b) Enter Lat/Lon: Fix to a manually entered Lat/Lon position
   c) Enter State Plane Coord: Fix to a manually entered State Plane Northing/Easting position
   d) Read From File: Fix to a position read from a *.ref file.
   e) Cancel: Cancel base setup

   If Read From GPS is selected, the software will read once from the GPS receiver, and then fix to that position. If Enter Lat/Lon is selected, a dialog box will open and a Latitude and Longitude must be input manually. If Enter State Plane Coord is selected, a dialog box will open allowing the input of a set of Northing/Easting coordinates by hand.

   Read from File will open a File>Open dialog and ask for the file name of the file to open.

   Regardless of which option is selected, after the position is determined, this position will be displayed, and dialog boxes will open to enter a station id and the measured base antenna height. Once these values are entered, base setup is complete and the "Exit and Save" button can be selected to exit the Equipment Setup menu.

   **Sokkia 500 Series**

   1. Turn on Sokkia
   2. Turn it Horizontally and Vertically to set it.
   3. Connect Sokkia to Carlson Field
   4. In Field go to Configure Field, and under equipment type put Sokkia
   5. To make sure the baud rate matches, under the Field menu go to Configure Field and click on Communication Settings and check the baud rate. On Sokkia press [ESC], then [CNFG]. Scroll down or enter 4 for "Comms setup." The baud rate can be changed using the arrow keys, when done press [ESC].
6. Exit the Configure Field menu.

7. To check if units (Ft /M) matches for correct results, in Carlson Field under Settings go to Drawing Setup and select the appropriate button. On Sokkia, in [CNFG] scroll to or enter 5 for "unit" and select appropriate unit using the arrow keys.

**Topcon Total Stations**
The Topcon instrument must have CR/LF (carriage return/linefeed) turned on for communication with Carlson Field.

**Topcon 200 Series**
To set CR/LF with 200 series:
1. Turn instrument off
2. Turn instrument on while holding F2 key
3. Choose F3 (Others set)
4. Press F4 (Page down)
5. Choose F3 (CR/LF) and set it on

To set this with 700 series:
1. Choose Parameter from the main screen
2. Scroll down until you find CR/LF and set it on

**Topcon ITS**
The command echo on the instrument must be turned off to work with Carlson Field.

**Topcon GTS-A4**
To setup the instrument hold down F-2 as you switch it on. This will bring up a parameters menu, press F-3 for Data Out. Hit Select to browse through the settings options, and make sure CR, LF: is ON and that Echo back: is OFF. Setup is complete.

**Topcon GTS-700**
To set the instrument to work with Carlson Field, press [F2] for "std" on the instrument.
Topcon 800-A Remote Setup

Topcon Setup:

Note: The instrument needs to be set to REC-A, not REC-B mode

1. Turn on the Topcon
2. Connect the Topcon to one of the radios, and the other radio connect to Carlson Field
3. Under Field menu go to Configure Field, and under equipment type select Topcon800A-Remote.
4. To set Topcon for external mode Press [F1] for "prog", then [F6] for "more". This will lead to more programs. Enter [F2] for "Ext.Link."
5. To select the radio channel, in External Link enter 2 for "settings" and 4 for "parameter (radio modem)", then 3 for "set channel". Using the arrow keys change the channel. When done press for [F1] for set, then press [ESC] until get back to External Link Menu.
Note: Channel on the Topcon should match the channel set in Carlson Field.
6. After channel is set press 1 for "Execute"
7. Topcon is ready.

Note: If the batteries are low either in Topcon or the radios, communication problems will arise.

Carlson Field Setup:

1. In Configure Field, under equipment type there should be Topcon800A-remote. In Communication Settings Baud Rate should be set to 9600.
2. After Configure Field go to Equipment Setup and make sure the radio channel or radio frequency matches the channel and frequency in Carlson Field. Press Ok when done.

Topcon 800A Quick Lock

1. Dismount the handle from the Topcon, and mount RC-2H. Secure it with the fixing screw.
2. Attach RC-2R to the prism, and turn it on.
3. Using the Y cable attach the RC-2H to the radio and Carlson Field.
4. In Joystick click on Quick Lock and Topcon will do angle turn until it finds a prism in which it will lock to, and will start tracking.

5. If RC-2H is not attached to the radio with Y cable, when Quick Lock is pressed the big yellow button on RC-2H needs to be pressed in order for the Topcon to search for the prism.

Trimble

Trimble NT300D

1. In order to properly configure the NT300D to work with Carlson Field, it must first be powered up in Setup mode (by holding down the [Setup] button on the front panel of the receiver while powering it on) so that the advanced setup options are available. Once the NT300D is powered up in this mode, bring up the Setup menu via the [Setup] button. Page down using the More menu option until the I/O menu item is available, and select it.

   a) In the I/O menu, select whichever port is to be used to interface the receiver with the computer running Carlson Field (Port 1 by default). Next, set both the input and the output to transmit/receive in NMEA, at 9600 baud rate. The final option, Remote Select, should be set to Primary.

   b) Now the NMEA sentences must be configured. From the I/O menu, enter the NMEA Sentences submenu. Disable all sentences, save for the GGA sentences and the GSA sentences. Ensure the Talker ID is GP. From here, Return to the I/O menu.

   c) The NMEA Control menu item, reachable from the I/O menu, has three options. The Output Rate here should be set to 1 second, the Position Output Rate set to Output Rate, and the NMEA Output Version to 2.1.

   Next, the GPS settings must be configured, and can be found in the GPS menu under the main Setup menu.

   The GPS Mode should be set to 3D, and the DGPS mode set to Auto. The DGPS source should be toggled to Internal, and the Pos/Vel Filter should be Off. Mask Values should be left at Default, and the SNR at M.

   Finally, the Beacon Receiver configuration (under Beacon Receiver on the Setup Menu) needs to have its Search Mode set to Auto-Dist Mode. All other values in all menus ought to either be left at their default settings, or configured as necessary to the local conditions (in the case of antenna height, etc.).

   2. The RMS value reported in Carlson Field is the RMS value of the standard deviation of the range inputs to the navigation process including pseudoranges and DGPS corrections.
The NT300D is now properly configured, and if connected to a computer running Carlson Field, will transmit position fix data to the computer automatically. Before using it, however, it is best to power it down and then turn it back on normally, as running it in Setup Mode is not recommended.

**Trimble 4000 Series**

Hardware Setup

1. Setup the antenna and GPS receiver as normal. The radio should be on I/O Port 2.
2. Connect the Computer that Carlson Field is running on to I/O Port 1 by the appropriate cable.

Front-Panel Configuration:

Base Station:

1. After powering on the receiver, press the [Control] Button. From the selections available, select MORE. This will bring up a second page of options. Select MORE again. The front panel screen should now be on RECEIVEDER CONTROL "3 of 7".
2. Select BAUD RATE/FORMAT, and from the menu that this creates, select SERIAL PORT 1 SETTINGS.
3. Ensure that the port is set to 38400 baud, 8-Odd-1 Format, with no flow control.
4. Similarly, make sure that the settings for I/O Port 2 agree with those of the type of radio being used (typically 9600 8-None-1).
5. Return to the RECEIVEDER CONTROL menu, and go to page 4 o 7. Select REFERENCE POSITION.
6. Enter the Lat/Lon of the position the base is located at. Alternately, select HERE to have the GPS unit read the current position and use that as the base reference point.
7. On page 1 of the RECEIVEDER CONTROL menu, select RTK OUTPUT CONTROL.
8. Set the RTK OUTPUTS to Port 2, and the ANTENNA HEIGHT to the measured height of the antenna.
9. Ensure that all other forms of output (Cycled Output, 1PPS output, Event Markers, etc.) are disable. These options may all be accessed with the submenus accessible through the [Control] button.
10. Ensure that the Synch time of the Rover and Base are the same. This setting may be accessed by first pressing [Control] and then cycling through the menus until the MASKS/SYNCH TIME option is available.

Rover Station:

1. After powering on the receiver, press the [Control] Button. From the selections available, select MORE. This will bring up a second page of options. Select MORE again. The front panel screen should now be on RECEIVEDER CONTROL "3 of 7".
2. Select BAUD RATE/FORMAT, and from the menu that this creates, select SERIAL PORT 1 SETTINGS.
3. Ensure that the port is set to 38400 baud, 8-Odd-1 Format, with no flow control.
4. Similarly, make sure that the settings for I/O Port 2 agree with those of the type of radio being used (typically 9600 8-None-1).
5. Return to the RECEIVEDER CONTROL menus, and go to page 2.
6. Select RTK ROVER CONTROL.
7. Toggle the ENABLE setting to L1/L2.
8. Push the [Status] button, and select POSITION. There should now be an RTK option. Select it. This will bring up a screen displaying delta Northing/Easting, correction status, etc.
9. Ensure that the STATIC option appears at the right. This means you are in kinematic/rover mode. If instead the ROVE option is available, select it.
10. Ensure that all other forms of output (Cycled Output, 1PPS output, Event Markers, etc.) are disable. These options may all be accessed with the submenus accessible through the [Control] button.
11. Ensure that the Synch time of the Rover and Base are the same. This setting may be accessed by first pressing [Control] and then cycling through the menus until the MASKS/SYNCH TIME option is available.

**Trimble 4700/4800**

Hardware and Equipment:

1. Make sure that the computer's serial port is connected to the 4700/4800 in it's COM1 port (typically the port that a data collector is normally plugged into). Power should be supplied on COM2, and any radio used for RTK should
be plugged into COM3.
2. All other equipment (antenna, wires, etc.) should be set up as normally directed by the manuals.

Software Configuration:

1. After selecting the Trimble 4700 equipment type from the "configure field" menu, open up "Equipment Setup."
This should bring up a new window/dialog box with the following options:
   a. Receiver Type: Select whether you are using a 4700 or 4800 receiver.
   b. Station Type: Choose what type of RTK station you are setting this receiver up as a base or rover.
   c. RTK Correction type: Select the type of Corrections you would like a base station to transmit. Note that CMR
      messages should be used for most precision applications, as RTCM is only capable of producing less-accurate
      floating precision positions
   d. Radio Baud Rate: The baud rate of the radio port. This should be left at the default setting of 9600 in general
   e. Satellite Elevation Cutoff: All satellites with elevation from the horizon of less than this number will not be used
      in calculating a position. This allows less accurate low elevation satellite to be factored out of a position.
   f. Configure Base Station: Will configure the receiver to act as a base. See "Configuring Base Station" below.
   g. Cancel without saving: Will exit this menu without saving any changes that have been made.
   h. Save and Exit: Will save these settings to the receiver and to Carlson Field's setup and exit out of this menu.

Configuring Rover:

No real configuration is necessary, aside from setting up the equipment and setting the appropriate Receiver Type,
Station Type, and Satellite Elevation Cutoff.

Configuring Base Station:

1. After selecting all the appropriate settings in "Configure GPS," click on the "Configure Base Station" button.
2. In the menu dialog that opens, there are a few buttons:
   a) Read from GPS: Read a position from the GPS and fix to that position
   b) Enter Lat/Lon: Fix to a manually entered Lat/Lon position
   c) Enter State Plane Coord: Fix to a manually entered State Plane Northing/Easting position
   d) Read From File: Fix to a position read from a *.ref file.
   e) Cancel: Cancel base setup

If Read From GPS is selected, the software will read once from the GPS receiver, and then fix to that position. If
Enter Lat/Lon is selected, a dialog box will open and a Latitude and Longitude must be input manually. If Enter
State Plane Coord is selected, a dialog box will open allowing the input of a set of Northing/Easting coordinates by
hand. Read from File will open a File
> Open dialog and ask for a file name of a reference file (*.REF) to open for
use in corrections.
Regardless of which option is selected, after the position is determined, this position will be displayed, and dialog
boxes will open to enter a station id (used by the base to identify itself to the rover(s)) and the measured base
antenna height. Once these values are entered, base setup is complete and the "Exit and Save" button can be selected
to exit the Equipment Setup menu. At this point, whenever looking at a menu that displays the connection status,
"REFERENCE" will be displayed, instead of Float, Fixed, or Autonomous.

**Trimble 5800**

Carlson Field Configuration:

In Configure Field, set the Equipment Type to Trimble Generic.

In Equipment Setup, be sure to set the Data Type to match your receiver setup. This Data Type is the port on the
receiver that communicates with Carlson Field. Typically, the Data Type should be set to 2 for the serial connection
and to 4 for Bluetooth.
When configuring the Base receiver, use a base station id number in the range from 1 to 32.
Point Clouds Module
Point Clouds Getting Started

Carlson Point Cloud is an application designed to run alongside IntelliCAD or AutoCAD and bring to the user ease in processing large point datasets. It provides several methods to reduce, clean, extract from, and otherwise manipulate these datasets so that they can be processed within CAD software without the typical memory limitations found in CAD applications.

All actions performed in Point Cloud are initiated through the Point Cloud Project Manager. This manager can be brought up from your CAD application (assuming that the Point Cloud module is loaded) via the Point Clouds Project Manager menu option or with the PC_PROJECT_MANAGER command. Work in Point Cloud is arranged into projects and each project maintains a tree structure of all the data it contains. Typically, when a new project is started you will want to customize the project's various settings before any work is done.

Note Windows XP Users: Prior to running Point Cloud, it may be helpful to enable the Windows /3GB switch to allow Point Cloud to use more virtual memory, this setting helps Point Cloud regardless of how much memory your computer has. Do not use the 3G switch unless your computer has 3 GB of Ram or more.

Point Clouds Project Manager

The project manager is the central place of operations for Carlson Point Cloud. To bring up the Project Manager, first ensure that the Point Cloud module is loaded by clicking on the lightning bolt icon in your CAD application. The manager can be brought up by either clicking the Point Clouds &arr; Project Manager or by entering the command PCPROJECT_MANAGER into your CAD applications command window.

Every function and operation that can be performed in Point Cloud is accessed through the Project Manager. These functions are divided up among five major categories represented as tabs in the project manager: Project, Scene, Camera, Action, and Data.

Command History

The Command History panel maintains a list of all major functions used since execution of Point Cloud began, and is also the central place where information regarding the results of all functions is posted, much like the command...
window in AutoCAD or IntelliCAD. For instance, after execution of the mesh simplification function has finished, details about the number of faces removed from the mesh will be appended to the Command History.

**Pulldown Menu Location(s):** Point Clouds  
**Keyboard Command:** pc_toolbar1  
**Prerequisite:** None

## Project Tab

The Project Tab is the main tab of the PointCloud Project Manager, and should be the first thing you see after pulling up the Project Manager. It is from here that you can manage your project files, as well as perform most of the operations on your datasets that affect them in their entirety. Interaction with items in the project is done via right-clicking them to bring up a menu with all the actions that can be performed on them.

![Project Tab](image)

### The Project Files Panel

This group of buttons all relate to the current working project. If there is no current working project the Close, Save and Save As buttons will be inactive.

- **New** Begins a new project. If there is already a project open the user will be prompted to save changes, close it, or cancel.  
- **Open** Opens an already existing project. If there is already a project open the user will be prompted to save changes, close it, or cancel.  
- **Close** Closes the current open project. If there are any unsaved changes, the user will be prompted if they wish to save them.  
- **Save** Saves the currently open project.  
- **Save As** Saves the currently open project to a new name specified by the user. Take note, this will not create new copies of the Mesh, Scan, and Cloud files.

### The Project Tree
Projects in Carlson PointCloud are arranged into a tree structure. Items in projects are divided into two separate categories: **Instrument Data** and **Processed Data**. **Instrument Data** consists of data in its raw form directly from the scanner that needs to be registered to a common coordinate system. This largely consists of raw *Scans* and the data associated with them (Target Points, Control Points, Reflectors, Images, etc). **Processed Data** is data that has been registered to a common coordinate system. Clouds, Contours, Coordinate Points, Grids, Layers, Meshes, Planes, Polylines, Profiles, Sections and Text all fall under this category. Scans, Clouds, and Meshes are the three central data objects to Carlson PointCloud and upon which most operations are performed.

**Scenes**

Scenes are 2D or 3D displays of various data types in the viewer. Multiple objects can be viewed in a single scene or you can set each item as an independent scene.

To create a scene with Point Clouds:

1. **Right-click** the object you want to view in the new scene.
2. **Select View**

The View Object dialog will be displayed.
Note: One exception is if you right-click an existing scene and select view, Point Clouds will display the selected scene in the viewer.

Action Panel

The Action panel determines whether to create a new scene for the object or to append the object to a scene that already exists.

Create new:

Append to existing:

Enter the name in the Name edit field for the new scene.

A list of existing scenes will become enabled to allow selecting the target scene. If there are no existing scenes The Append to Existing option will be grayed out.

Name Panel

The name edit field and the list of existing scenes are used to assign the name of the scene for the object to be viewed.

Mode Panel

The Mode panel determines the dimensions to view the data in, 2D or 3D. Viewing the data in 2D mode will only be available if the dataset can be laid out on a two dimensional plane (scans, profiles, and images). Additionally, selecting 2D mode will not add a new scene to the project, it will only create a temporary scene to view the data in, because there is no reason to view multiple objects in the same 2D view (the objects would all obscure each other).

Color Panel

The Color panel determines the mode to color the data in. There are eight color modes. The available modes depend on the data selected for viewing and the mode it will be drawn in. These color modes are divided up into categories based on how the colors are determined, these categories are:

<table>
<thead>
<tr>
<th>Category</th>
<th>Type</th>
</tr>
</thead>
</table>

Chapter 11. Point Clouds Module
**Simple:** Colors the entire dataset the same color

**Position:** Colors each point based off its world positioning data.

**Intensity:** Colors each point based off of its single intensity value.

**Color:** Colors the points based off their color information.

**Direct:** Colors the entire dataset a single color. The color can be chosen in the Scene tab of the Project Manager.

**Elevation:** Colors each point in a range from blue being the minimum elevation value to red being the maximum color value.

**Range:** Colors each point based off its distance from the origin (or scanner if the current object being viewed is a scan), black being the minimum distance and white being the maximum.

**Normal:** Colors each point based off the normal of the surface at that point. In the Normal mode, each color dimension (red, green, and blue) are assigned a spatial dimension (x, y, and z) to represent that direction in the objects finally color.

**Direct:** Color each pixel in the range from black to white based off its intensity value.

**Scaled:** Scale the range of intensities so that the minimum intensity in the data set matches up with zero and the largest intensity in the data set will match up with the maximum possible intensity value, which can make minor changes in intensity more noticeable.

**Equalized:** will perform a similar scaling operation but do it in a manner that will equalize the histogram of the intensity values, making it so that all intensity values occur equally often, this method can also make minor changes in the intensity much more noticeable.

**Direct:** Colors each point directly by its internal color value.

**Grayscale:** Colors each point by the grayscale representation of its internal color value.

In addition to the above method of scene creation, you may also create a scene by right clicking the scenes folder and selecting **Add &rArr; New** from the menu. This method will allow you to create a scene with multiple objects in it without having to go through the dialog several times.
The right half of the dialog is the same as single object viewing, but the left half of the dialog shows a tree structure representing objects in the project that can be added to the scene. Click on the red x icon next to an object to toggle inclusion of that object in the scene.

**Note:** When viewing any of the large object types (scans, meshes, and clouds) there is only one copy of that object retained in memory at all times. This is done to preserve memory as much as possible when opening up multiple views of the same object. This also means that any changes made to the object in one view will be reflected in all other views of that object. For instance, if you're viewing a scan in two views and wish to clean up its data, deleting points from the scan in one view will change the scan in any other views of it. When all views of an object have been closed, the object modified dialog will be displayed prompting the user for an action to perform with the modified data.

This dialog is very similar to the one used in the **Action** tab when edits are made there. **Modify existing** will save the changes to the original object. **Create new** will create a new object to save the modified data to and is typically the safer option because the original data is still available if needed. **Discard Changes** will close the scene without saving the changes leaving the scan unaltered.
PointCloud Viewer

The Carlson PointCloud viewer is where all virtual surveying and visual inspection of data is done in PointCloud. It has both 2D view mode functionality for viewing images and scans (as a flat image) as well as 3D view mode for viewing three dimensional data. Drawing in the viewer is divided into two different modes, dynamic and static. Dynamic mode draws a greatly reduced version of the current scene to improve draw speeds, while static mode will draw the full detailed scene. Typically, the viewer will run in dynamic mode when the user is attempting to do something interactive that involves camera, such as rotating the scene or zooming in, and it will draw in static mode when the camera isn't being manipulated. Options that pertain to how much detail is drawn in the current scene in dynamic and static mode can be changed in the Scene page of the Project Manager.

By default, the left mouse button operates in an orbit mode similar to the 3D viewer in the Carlson Civil Suite, the middle mouse button pans, and the right mouse button zooms. Mouse behavior for the current viewer can be changed in the Camera Tab of the Project Manager.

The Camera Shortcuts Toolbar and Menu

The toolbar and the menu at the top of the viewer have several shortcuts to functions commonly used in the Camera page. These icons and their functions are as follows (from left to right):

- **Top Extents** places the camera directly above the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.
- **Bottom Extents** places the camera directly above the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.
- **Front Extents** places the camera directly out along the negative y axis from the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.
- **Back Extents** places the camera directly out along the positive y axis from the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.
- **Left Extents** places the camera directly out along the negative x axis from the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.
Right Extents places the camera directly out along the positive x axis from the center of the scene's bounding box, and will manipulate the camera's properties to allow visibility of the entire scene.

Scanner position moves the camera to the scanner position of a scan in the scene, if there is more than one scan this button will cycle through each of the scanner positions, if there are no scanner positions, this button does nothing.

Orthographic Projection sets the camera to parallel projection mode.

Perspective projection sets the camera to perspective projection mode.

Zoom To Window allows the user to select an area to zoom into. First click will place the first vertex of the zoom window and the second click will complete it and zoom the viewer to fit the window.

Zoom extents moves the camera to show the extents of the full scene, if in parallel projection mode, changes the width of the projection to fit the scene.

Zoom Previous resets the Point Cloud viewer to the previous view limits and orientation.

Save PDF Provides the user with settings to save the current view to a PDF format with borders and user specified title block information.

Distance Click this icon to check distances between points. Distances will be reported in Command history window. Click this icon a second time to end the distance function.

Layer Properties Manager This button opens the Layer Properties Manager dialog box. Information regarding the Layer Properties Manager is found under the common Utilities section.

The first 12 Toolbar option (from left to right) are also available by click on the Camera button just above the icons. Options here are presented in fly-out menu format.

Orbit

The Orbit guide displays a primary circle with circles at the cardinal directions. These circles help guide the user when performing three dimensional rotations of the scene.

The Bounding Box

The scene bounding box is an axis-aligned box that encompasses the full range of the data currently in the scene. The bounding box is used indirectly in several functions that affect the entire scene.

The Pivot Point

The current camera pivot is represented by a point in the scene, which is red by default. When the camera is working in Orbit mode, this point is the point that the camera orbits around when you drag the mouse. By default, this point moves to the valid data nearest to your cursor when you press the left mouse button in Orbit mode, but this behavior can be changed in the Camera Tab.

The Reference Point
The current reference point is represented by a point in the scene, which is yellow by default. It is used for preliminary data checking without having to create any objects in the project itself. All functionality that uses the reference point can be found on the Data Tab.

**The Elevation and Range Legend**

The elevation and range legends display the range of elevation/range colors and the values associated with those colors in the current scene. The values associated with each color are not absolute and can change from scene to scene. Elevation coloring ranges from Blue, as the minimum elevation, to Red, as the maximum elevation, while range coloring ranges from white being the closest point to black for the furthest. The ranges for range coloring are calculated from the distance between the origin to the current point in clouds and meshes, while for scans the scanner position is used.

**The Orientation Axes**

The orientation axes are the red, blue, and green arrows that are located in the bottom left of the viewer by default. These show how the current camera's view direction relates to the world axes and can be useful when determining what direction the camera is looking in. The red arrow is the x axis, the green arrow is the y axis, and the blue arrow is the z axis. The size and position of the orientation axes can be changed in the Project Settings dialog.

**The Status Bar**

At the bottom of the viewer is a status bar that is divided up into four blocks. The leftmost three of these blocks display the x, y, and z position information of the data under the cursor (if it is valid data), and the fourth block displays any prompts to the user that may be important.

**Customizing the Viewer**

There exists several options for customizing the PointCloud viewer; these options can be found in the Project Settings dialog, which can be accessed from the Project Tab of the Project Manager at the bottom of the project's tree structure. See documentation on the Project Settings for more information about these options.

**Project Settings**

The Project Settings dialog allows the user to modify various project-wide settings that fall under three categories: Units and Ranges, Naming Conventions, and 3D Viewer Settings. It is usually best upon creation of a project to first go to this dialog and make sure that these settings are ideal for the work to be done.

**Units and Ranges**

The Units and Ranges page of the Project Settings dialog allows the user to specify their desired working units and their desired ranges for color values retrieved by the scanner.
These values will be internally used by Point Cloud and any values exported from Point Cloud or drawn to any CAD software will be in these units. Any time a scan, cloud, or mesh is imported whose units are different from these internal formats, its data will be converted to the internal format. For instance if the project's units are set to feet and you import a scan with ranges specified in meters, the scan's units will be converted to feet as it is imported.

**Naming Conventions**

The Naming Conventions page of the Project Settings dialog allows the user to specify the default naming behavior for each of the major item types in Point Cloud.

By default, when objects are created they will be given the names specified in the Naming Conventions dialog followed by the smallest number with the specified number of digits that will give it a unique name. For instance, using the above settings, if a project already has "Mesh 01" and "Mesh 02" objects and the user creates a third mesh, this third mesh will be given the default name of "Mesh 03". Additionally, the user can also specify suffixes to be added to datasets after they have been processed in some manner. Given the above settings, if a mesh, "Mesh 01",...
were simplified with the above settings its simplified mesh would be given the default name of "Mesh 01 - Simplified 01". In most cases where new objects are created, the user will have the option to change the new object's name from the one automatically generated from these settings.

**Viewer**

The Viewer page of the Project Settings dialog allows the user to customize various settings of how the Point Cloud viewer window looks.

![Project Settings Dialog](image)

The Axes options specify the size of the orientation axis as well as its relative position in the viewer. The axes show the orientation of the three axes with respect to the current camera's view direction. Its size is in pixels, so the axes will not scale with the window size.

**The Orientation Axes**

The bounding box options specify the size of the lines (in pixels) that outline the extents of the current object in the viewer as well as their colors.
A Mesh with its Bounding Box

The Grid options specify whether to draw a grid when in parallel projection mode, as well as the grid line sizes and their colors.

The Orbit options are for drawing a graphical orbit on screen, which is useful for restricting camera movement along a specific axis. When working with the orbit control, dragging with the mouse starting in the small circles on the left and right locks the camera to the x axis, while starting in the circle on the top and bottom locks it to the y axis. Starting a mouse drag outside the big circle locks the camera to the z axis.

A Scene with the Orbit Control Enabled

The Pivot Point and Reference Point settings specify the size and color of the points drawn to represent the current pivot and the current reference point, respectively. The pivot is the current pivot for the camera, which the camera rotates around in Orbit mode and the reference point is the current point of reference which is used in the data page for relative distance checks and some other functions.

The Elevation / Range Legend options specify whether to draw the legends for these values (if the current dataset
being viewed has consists of Elevation or Range data). These legends show the elevation / range values associated with colors values for objects colored by elevation / range.

The Elevation Legend

The OpenGL Settings toggle allows the user turn hardware acceleration on or off. The default is on.

**Tab Location(s):** Project Tab

**Prerequisite:** Open Point Cloud project

**Action Tab**

The **Action Tab** is the fourth tab in the **Point Cloud Manager**. It is here where all data extraction, as well as virtual surveying, is done in Carlson Point Cloud. There must be a currently open scene with 3D data for the controls in the action page to be enabled; otherwise they will be ghosted out.

Actions that can be taken with a scene are broken up into five different Panels: Selection Set, Edit, Transform, Create, and Extract. These categories are arranged such that operations that you would typically do first are at the top of the page, for instance, you must select the data you wish to modify before hiding any of it, or if you're going to transform the data you would perform transformations before you extract any of it.

**CTRL Key Setting**

The CTRL Key Setting controls how selection is done in the scene window. The default is **use CTRL Key to Pick**. This means the user must hold the CTRL key down and left click in the scene to select point or create points, polylines or text. The other option is **Use CTRL Key to Navigate**. This option allows the user to simply left click to make selections in the scene.

**Selection Set Panel**

The four radio buttons at the top of the Selection Set panel operate as two sets and determine the behavior of the selection methods (Individual, Rectangle, Polyline and Inclusion).
Add/Remove determines whether the objects that pass the criteria of the selection method are added or removed from the current selection set. 

Inside/Outside determines whether to perform the selection operation on all entities inside or outside the drawn rectangle/polyline.

There are four selection modes:

**Individual**, in which every mouse click attempts to select the object currently under the cursor, useful for precision selection of individual points.

**Rectangle**, in which the user clicks a base point and a second point that defines the opposite corners of a selection rectangle.

**Polyline** in which the user clicks several times to define the shape of the polyline and right-clicks to close the polyline.

**Inclusion** in which the user selects a polyline previously drawn in the scene using the create Polyline command.

There are also four global selection buttons:

**All**, which selects all entities in the scene.

**None**, which deselects all entities in the scene

**Invert**, which inverts the current selection set within the scene.

**Elevation**, The user specifies a maximum and minimum elevation and the selection set is built from points between the specified elevations. Points outside the elevation range are ignored.

**Edit Panel**

The **Edit** panel contains controls for modifying the currently visible set of points.

The **Information** button displays a properties dialog with some general statistical information about the current selection set, including the number of points selected, ranges of their positions, and ranges of the color and intensity values.

The **Delete** button deletes the selected points from the scene and from the objects that contain them, if you delete some points from a scan, or faces from a mesh, you will be prompted for an action to take with the modified object's data after all scenes containing that object are closed.
Modify existing will save the changes to the original object (deleting points from the object as it is on disk, which cannot be undone).

Create New will create a new object to save the modified data and is typically the safer option because the original data is still available if needed.

Discard Changes will close the scene without saving your changes (deletions).

The Hide button temporarily hides the current selection set, which can help isolate the current area of interest without making permanent changes to the dataset.

Show All undoes all hide operations and will display everything in the scene again.

Image allows the user to drape an image over a mesh.

Smooth and Clean are functions performed on meshes only.

**Transform Panel**

The Transform panel contains several functions that relate specifically to transforming the current selection set. This allows for minor adjustments to be made to the selection set if it seems that data isn't properly aligned or if you want to move individual coordinate points to different locations.

Translate allows you to define a translation of the current data set by selecting a base start point and an ending point. Activating the translation mode will bring up a new panel in the action page that displays the current base point and end point of the translation as well as the resulting vector. A first click in the viewer will define the base point for the vector of translation and a second click will define the end point of that vector.

Rotations allow you to rotate the current selection set with three clicks. The first click will define the center of rotation, and the angle of rotation will be determined from angle between the vectors made between the second and third clicks and the first click.

Scaling is performed with two clicks. The first click defines the origin of the scaling operation, and the magnitude of the vector between the first and second vectors determines the magnitude of the scale operation.

Sequence brings up a separate dialog that allows you to define a sequence of transformations and allows you more precision than allowed by the other three methods.

Initially, the dialog will have no transformations specified, to add a transformation, press the + button. After pressing this button another dialog will pop up with all the options for the new transformation to add to the sequence.
There are four kinds of transformations you can choose from in the list box: Translation, Rotation, Scaling, and Advanced. Each of the simple translations are the same as they are in the transform panel, only you must provide the actual numbers instead of interacting via mouse-clicks. The advanced transformation allows you to specify a transformation matrix to be applied to data. After clicking the check button you should be taken back to the Transform Selection Set dialog. From here you can add more transformations, modify the currently selected one by pressing the green i button, delete them by pressing the red x button, or change their order of application to the data using the green arrow buttons. Press the check button in the Transform Selection Set dialog to apply the transformations to the selected data.

Similar to the Delete button in the Edit panel, when a cloud has been transformed and is about to be closed by the program, the user will be asked by the program for the desired course of action. The Cloud Modified dialog will pop up with the option to either save the changes to the already existing item, create a new object with the changes made, or just throw away the changes.

Create Panel

The Create Panel allows you to manually create new project items either by specifying their points in the viewer (Point Polyline and Text) or by creating a new data set from the currently selected data points (Cloud, Mesh and Grid).

Create Point

Clicking Point in the Create Panel will set the Current Mode to Point Creation and display the four panels that comprise the point creation mode.

Create Polyline
Clicking **Polyline** in the Create Panel will set the Current Mode to Polyline Creation and display the four panels that comprise the polyline creation mode.

### Create Cloud

Clicking **Cloud** will bring up the standard Point Cloud creation dialog. In this case it will create a cloud with all the selected data in the current scene.

### Create Mesh

Clicking **Mesh** in the Create Panel will bring up the standard Mesh Creation dialog. In this case it will create a mesh with all the selected data in the current scene. However, one minor change is that the **Normal** panel has a **From Scene** option radio button which will make the mesh pull in its normal from the current camera's view direction. This allows you to view a scene of data and find an optimal viewing angle that gives the best results as a normal for the mesh.

### Create Text

Clicking **Text** in the Create Panel will set the Current Mode to Text Creation and display the two panels that comprise the text creation mode.

### Create Grid

Clicking **Grid** in the Create Panel will bring up the standard Grid Creation dialog. In this case it will create a Grid with all the selected data in the current scene.

### Extraction Panel

![Extraction Panel](image)

Each of the Data Extraction functions is designed for use on a fully processed mesh object. Results for these functions not used with a mesh may not be accurate. Because of their complexity each extraction function, Extract Breaklines, Extract Contours, Extract Profile, Extract Section and Extract Bare Earth has its own help pages.

### Create Point

Selecting the **Point** button from the Create panel in the **Action Tab** will open the Create Point dialog. The Current Mode will be set to Point Creation.
Snap Mode Panel

The Snap Mode Panel offers twelve different options for snapping to points in the cloud in the open scene.

- **None** - No snap function is active. The point will be placed at the cloud point nearest to the selected location.
- **Low** - The point is placed at the lowest point (smallest z value) within the Snap Radius.
- **High** - The point is placed at the highest point (largest z value) within the Snap Radius.
- **Low Edge** - Snaps to the low edge of a feature, like a curb. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.
- **High Edge** - Snaps to the high edge of a feature, like a curb. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.
- **Slope Bottom** - Snaps to the bottom edge of a slope that is less than 45 degrees. This is useful for finding low edges on mountable curbs and other non-vertical features.
- **Slope Top** - Snaps to the top edge of a slope that is less than 45 degrees. This is useful for finding upper edges on mountable curbs and other non-vertical features.
- **Average Point** - This snap averages Northing, Easting and Elevation for all points within the Snap Radius and uses the averaged values for the coordinates for the new point.
- **End Point** - Snaps the new point to the endpoint of an existing polyline.
- **Mid Point** - Snaps the new point to the midpoint of an existing polyline.
- **Node** - Snaps the new point to points placed in the drawing using Carlson Point Cloud Create Point.
- **Nearest** - Snaps the new point to the point on an existing polyline nearest to the cursor location.

Feature Points Panel

Feature points are specific types of features that Carlson Point Cloud can extract and list data for. These features are extract as 3D cylinders and other 3D elements to reflect the feature selected and display the general shape in the Point Cloud scene. The screen captures below show the various cylinders for each feature type. There are four options in the Feature point drop list.
None - No Feature type is selected.

**Tree** - The user picks a point near the bottom of a tree in the scene and the trunk diameter, height, and drip line diameter are extracted and displayed as the description for the point.

**Pole** - The use picks near the base of a pole in the scene and the diameter and height are extracted and displayed as the description for the point.

**Hydrant** - The use picks near the base of a hydrant in the scene and the diameter and height are extracted and displayed as the description for the point.

**Use SZ Code** - When toggled on this command will change the description displayed in the scene and stored in the Coordinate list. The new description is coded to take advantage of special codes in Field to Finish to more accurately display the features. Size or height, rotation and diameter or width. By setting up the Field to Finish file (.FLD) to...
place 3D blocks and use the special codes placed in the description by Point Cloud a more realistic and accurate 3D view can be created in CAD. **Hide Feature Points** - When toggled on this command will "hide" or remove from the scene that points that make up the feature selected. For example, if feature type Pole is active and you select the base of a pole, the points that display as the pole in the scene will be hidden. A coordinate point is placed showing the diameter and height of the pole. **Note:** If the Hide Feature Points is toggled on and features are selected the user will be prompted to update the cloud, save a new cloud or discard changes when closing the scene.

**Create Point**

The Create Point panel displays options for creating a point.

In the Create Point panel you can choose the destination of points created using the Active List drop list. Points created will be added to the list displayed in the Active List. Three options are available.

- Control Points
- Scan Position
- Coordinate Points

**Point Number** determines the number to be assigned to the point. There are two options for numbering.

- **Increment Current** will follow the standard numbering convention of Carlson Civil Suite (increment the number without any filler digits).
- **From Settings** will use the prefixes and digits from the naming Conventions in the **Project Settings**

**Code** will bring up the Point Cloud Code Table dialog.
Pick FLD File allows the user to set the current field-to-finish file (.FLD). Once an FLD file is open the user can select a code to use to create points by click the desired code and then clicking the Green check mark.

**Field-to-Finish Linework**

The Field-to-Finish Linework panel allows you to specify properties of the next field-to-finish linework segment (if the current code table entry has linework associated with it). If your code does not specify linework you will receive a message that your code does not have linework associated. Once you clear the message dialog your point will be placed and the linework options will be set to **None**.

Once a code is selected from the Create Point panel the user may select one of the Field-to-finish Linework radio button options.

**None** no linework is created. This is the default when a Point code without linework is selected.

**Start Line** Begins a line using the parameters in the code table. Lines are only created for point codes that have linework associated with them.

**Continue** is selected as you continue adding points to the current field-to-finish linework.

**Start Curve (PC)** Sets the starting point for an arc. The arc will be drawn using the parameters in the code table.

**Prompts**
Specify Vertex Position: Places a point at the selected location. If the point Code is associated with line work the point is connected to the previous point with a line.

Tab Location(s): Action Tab
Panel and Button: Create and Point
Prerequisite: An open scene of a point cloud

Create Polyline

Selecting the Polyline button from the Create panel in the Action Tab will open the Create Polyline dialog. The Current Mode will be set to Polyline Creation.

The Snap Mode Panel offers twelve different options for snapping to points in the cloud in the open scene.

- **None** - No snap function is active. The vertex of the polyline will be placed at the cloud point nearest to the selected location.
- **Low** - The polyline vertex is placed at the lowest point (smallest z value) within the Snap Radius.
- **High** - The polyline vertex is placed at the highest point (largest z value) within the Snap Radius.
- **Low Edge** - Snaps to the low edge of a feature. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.
High Edge - Snaps to the high edge of a feature. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.

Slope Bottom - Snaps to the bottom edge of a slope that is less than 45 degrees. This is useful for finding low edges on mountable curbs and other non-vertical features. Slope Top - Snaps to the top edge of a slope that is less than 45 degrees. This is useful for finding upper edges on mountable curbs and other non-vertical features. Average Point - This snap averages Northing, Easting and Elevation for all points within the Snap Radius and uses the averaged values for the coordinate for the new polyline vertex.

End Point - Snaps the new polyline vertex to the endpoint of existing polylines.
Mid Point - Snaps the new polyline vertex to the midpoint of existing polylines.
Node - Snaps the new polyline vertex to points placed in the drawing using Carlson Point Cloud.
Nearest - Snaps the new polyline vertex to the point on an existing polyline nearest to the cursor location.

The Create Polyline Panel sets options for creating polylines from the Point Cloud. Each option is discussed below.

Point Number - This options allows the user to draw polylines between points created by the create point command. Simply type the starting point number in the Point Number field and press enter. Type the next point number and press enter. A polyline is drawn between the numbers entered. Continue entering point numbers to draw more segments. The point numbers must be in the Coordinate Points list found on the Project Tab.

Segment Mode - Segment mode can only be used when the Snap Type is set to High Edge or Low Edge. Segment Mode creates a best fit polyline between the two selected points by breaking the selected distance into smaller segments with length equal to the snap radius. A point is found at each new segment location and a best fit line created through the resulting points.

Polyline Layer - Users can specify the layer to draw the new polyline on by typing a name in the Polyline layer field. Users may also click the Select button and select any layer currently in the scene or they may create a new layer to be used by typing it at the bottom of the Select Polyline layer dialog box.

Undo - Removes the last polyline segment drawn and allows the user to continue the polyline creation from the previous endpoint.

Draw Arc - Draws a three point arc in the current polyline using the last point selected as the PC. The user is prompted to specify second point on arc. A line will display for the PC to the POC. After selecting the second point the user is prompted to specify end point of arc. The arc is drawn and the line from the PC to POC is gone.

Draw Curb - The draw curb toggle when selected activates the Curb Settings Button

Curb Settings - There are three curb types to choose from by clicking the radio button below the desired curb type.
The Dimensions for each curb can be specified using either feet or inches. The curb direction is relative to the direction you select the curb points in.

The polyline created from your picked points will be named like any other polyline you draw. The additional polylines created from the draw curb routine will include the name of the main polyline and a suffix number.

Below is an example of polylines created using Curb Type 1.
The Active Polyline Panel controls the polyline creation for the current or active polyline. There can be more than one active polyline at a time. The polyline that is being worked with will be highlighted in the list of polylines that are active. You can change polylines you are working by clicking them in the active list. It is recommended to work with only one polyline at a time, ending its session when you are to avoid confusion with multiple active polylines.

**New** - Starts a new polyline

**End** - Ends the polyline that is highlighted in the list of Active Polylines

**Close** - Closes the current polyline to its starting point

**Edit** - Opens the Edit Polyline dialog box. The Edit Polyline dialog box can also be accessed by double clicking a polyline on the project tab or right clicking a polyline on the project tab and selecting Edit. For more information on the Polyline edit Dialog box see **Polyline Editor**

**Draw to CAD** - Draws the active polylines into the current CAD file.

The Screen Pick Action Panel provides options for editing polylines in the active scene. Each option is discussed below.

**Edit Vertex** - The user is first prompted to select the polyline they want to edit. After selecting a polyline the user is prompted to pick near the point to edit. The dialog box below is presented to the user.
The user can change coordinates by typing in the X, Y or Z fields or screen picking. There are buttons to advance to the Next vertex or return to the previous vertex. The user can also change the point type from basic to Coordinate Point reference.

**Add Vertex** - The user is prompted to select the polyline to add a vertex to and then to select the point to add. Vertices can be added until the End Add Vertex button is clicked.

**Remove Vertex** - The user is prompted to select the polyline to remove a vertex from and then to pick the vertex to remove. The user can continue to remove vertices until the End Remove Vertex button is clicked.

**Activate** - The Activate button can be used to make a polyline previously drawn active again so you can add on to that polyline. The user is prompted to select the polyline to activate. Multiple polylines can be activated. Click the End Activate button before trying to work with one of the activated polylines.

**Delete** - The user is prompted to select the polyline to delete. There is not an undo command for this delete function.

**Tab Location:** Action  
**Panel and Button:** Create Polyline  
**Prerequisite:** Open Point Cloud Scene

**Create Text**
Selecting the Text button from the Create panel in the **Action Tab** will open the Create Text dialog. The Current Mode will be set to Text Creation.
Snap Mode

The Snap Mode Panel offers twelve different options for snapping to points in the cloud in the open scene.

- **None** - No snap function is active. The text will be placed at the cloud point nearest to the selected location.
- **Low** - The text is placed at the lowest point (smallest z value) within the Snap Radius.
- **High** - The text is placed at the highest point (largest z value) within the Snap Radius.
- **Low Edge** - Snaps to the low edge of a feature. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.
- **High Edge** - Snaps to the high edge of a feature. A dynamic window in the upper left of the scene displays a cross section of the area within the Snap Radius and displays the high and low edge as red squares.
- **Slope Bottom** - Snaps to the bottom edge of a slope that is less than 45 degrees. This is useful for finding low edges on mountable curbs and other non-vertical features.
- **Slope Top** - Snaps to the top edge of a slope that is less than 45 degrees. This is useful for finding upper edges on mountable curbs and other non-vertical features.
- **Average Point** - This snap averages Northing, Easting and Elevation for all points within the Snap Radius and uses the averaged values for the coordinate for the text.
- **End Point** - Snaps the text to the endpoint of existing polylines.
- **Mid Point** - Snaps the text to the midpoint of existing polylines.
- **Node** - Snaps the text to points placed in the drawing using Carlson Point Cloud.
- **Nearest** - Snaps the text to the point on an existing polyline nearest to the cursor location.

Create Text Panel

The Create Text Panel sets options for creating text in the Point Cloud. Each option is discussed below.

**Text** - This is the text that will be placed in the scene.

**Leader Segments** - This value specifies the number of segments a leader will have. The text is placed at the segment endpoint.

**Text Size** - text size is a fixed unit. This means that as the user zooms in and out the text is always the same size on the screen and not relative to the cloud.

**Alignment** - There are nine alignment options for the text relative to the text location picked.
  - **Top Left**
Tab Location: Action
Panel and Button: Create and Text
Prerequisite: Open Point Cloud Scene

Create Grid

Selecting the Grid button from the Create panel in the Action Tab will open the Create Grid dialog. Move the cursor into your Scene window. You will be prompted to pick the two opposite corners of the area to grid. Once the corners are selected the Create Grid dialog box will open.

![Create Grid dialog]

Name

The default name of the new grid is controlled through Settings on the Project panel. Statistical information about the area selected will be shown below the name field. For best results work in Plan view with the X axis pointing to the right and the Y axis pointing up.

Elevation Method

- **Local Maximum** - Uses the maximum elevation within a grid cell as the cell elevation.
- **Local Minimum** - Uses the minimum elevation within a cell as the cell elevation.
**Cell Average** - Uses the average of the cell elevation as the elevation for the cell.

**Specify Grid Resolution As**

![Specify Grid Resolution As](image)

The grid Resolution may be specified in either the number of cells in the X and Y direction or by the size of each cell. After selecting a method you may adjust the values for X and Y. The total number of cells that will be created is shown below the X and Y values.

**Note:** If the size of your cell is less than the distance between points in your cloud you will have holes or void areas in your grid. If this occurs you can select the same area and create a grid with larger cell dimensions or a fewer number of cells.

To end the Grid Creation mode click the End Mode button at the top of the Action tab.

**Tab Location(s):** Action Tab  
**Panel and Button:** Create and Grid  
**Prerequisite:** An open scene of a point cloud

**Image Drape**

The Image Drape mode is accessed by clicking the **Image** button in the Edit panel of the **Action Tab**. Two Panels make up the Image Drape dialog box.

![Image Drape](image)

**Current Mode**

The Current Mode panel displays the current mode, in this case Image Drape. The **End Mode** button ends the Image Drape mode and closes the dialog box. The user is returned to the **Action Tab** default dialog box.

**Image**

If an image is currently draped in the scene, its file name will be listed in the Image panel. The two functions of the Image panel are:

- **Select Image** - This button opens the Select Overlay Image dialog box allowing the user to browse for the image they wish to use. Supported image formats include; BMP, JPG, JPEG, TIF and TIFF.  
- **Remove** - This button removes the current image from the scene. If there is no image in the current scene this button has no effect.

**Tab Location:** Action Tab  
**Panel and Button:** Edit and Image  
**Prerequisite:** Open scene of a mesh and an image file that is georeferenced
Extract Contours

Extract Contours

Clicking the **Contours** button in the extract panel of the **Action Tab** will bring up a separate dialog with options relating to extracting contours from the current scene.

![Extract Contours Dialog](image)

The **Interval** extraction method extracts contours at every multiple of elevation interval between the minimum and maximum elevation values (a minimum of 2.5 and an interval of 5.0 would have the first contour elevation be at 5.0). The **Elevation** method only extracts the contours at the specified elevation value. By default, the **Minimum** and **Maximum** elevation values are the minimum and maximum elevations of current scene and clicking the calculator icon to the right of each of these values will return them back to their default values. **Min Length** determines the minimum length of a contour line to be drawn. Upon extraction, contours will be given an automatically generated name and added to the **Contours** folder in the project tree.

**Contour Smoothing**

The **Apply Outlier Reduction Filter** reduces spikes in contours from errant points.

**Reduce Vertices** removes vertices from the contour polylines provided the removed vertex is not further away from the new line than the **Offset Distance**

**Reduce Before Bezier Smoothing** works in a manner similar to reduce vertices using its own **Offset Distance**

**Smoothing** - Sliding the bar to the left results in a lower setting which will have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

If **Draw planes** is enabled, plane objects will be added to the project and the scene that cut the through the scene at each extracted elevation level.

**Tab Location:** Action

**Panel and Button:** Extract and Contours

**Prerequisite:** Open Point Cloud Scene of a Mesh
Extract Sections

Sections can be extracted in two kinds of coordinate systems: **Real-World** and **Camera View**.

**Real-World** is the most commonly used method and extracts the sections in the current scene's coordinate system. The z values, or elevation values, are those found in the surface the sections is being extracted from. **Camera View** is much less commonly used and uses the current camera as the origin instead of the scene's origin, and elevation values are effectively distances from the camera. This mode can be useful if you're trying to extract sections out of a vertical surface such as a wall or are trying to get sections of an object from a direction other than the z axis. **Camera View** mode gives the best results if the current camera is in parallel projection mode (perspective mode will distort the profile).

The width of the sections and the frequency at which they are extracted along the designated path are controlled by three parameters.

**Left Offset** is the distance left of the path the sections will extend. Left is determined base on the direction the extraction path was drawn or "up station".

**Right Offset** is the distance right of the path the sections will extend. Right is determined base on the direction the extraction path was drawn or "up station".

**Interval** is the value that determines the distance along the path between sections.

The **Polyline Simplification** option will remove each vertex that is within a certain distance to its least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Threshold is a positive number that determines the distance under which vertices will be removed from the polyline.

The **Polyline Smoothing** option will smooth each vertex in the polyline using a least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Factor is a number between 0.0 and 1.0, 0.0 being no smoothing performed and 1.0 being fitting each vertex to its respective least squares line (usually makes the polyline extremely linear given a window size greater than 8).

If **Draw Planes** is enabled, Plane objects will be added to the project and the scene that follow each section line.

**Extract Along Centerline** when clicked the user is prompted for the .CL file to use. The horizontal location of the centerline is extracted the sections from the mesh.
After these options have been set to the preferred values, the user can extract the sections by left clicking in the viewer to draw the path polyline and right clicking to end it. The sections are saved to the project and can be drawn in CAD or exported to a .SCT file from the **Project Tab**.

**Prompts**

**Left-click to create polyline** Left-click in the viewer to create the polyline for the profile, Right-click to end the polyline.

**Tab Location(s):** Action Tab  
**Panel and Button:** Extract and Sections  
**Prerequisite:** Open scene of a mesh

---

**Extract Profile**

The profile extraction functionality can be activated by going to the Action Tab and clicking the **Extract Profile** button. The only requirement for profile extraction is that the data that you're trying to extract a profile from is a mesh. Although Carlson PointCloud will try to extract a profile from a cloud or scan if attempted, the results are rarely ideal. Pressing the **Extract Profile** button also puts the current viewer into profile extraction mode, which will show a tooltip with instructions on how to extract the profile and clicking in the viewer will draw the profile. To exit profile extraction mode, click the **End Mode** button.

Profiles can be extracted in two kinds of coordinate systems: **Real-World** and **Camera View**.

**Real-World** is the most commonly used method and extracts the profile in the current scene's coordinate system. The z values, or elevation values, are those found in the surface the profile is being extracted from. **Camera View** is much less commonly used and uses the current camera as the origin instead of the scene's origin, and elevation values are effectively distances from the camera. This mode can be useful if you're trying to extract a profile out of a vertical surface such as a wall or are trying to get the profile of an object from a direction other than the z axis. **Camera View** mode gives the best results if the current camera is in parallel projection mode (perspective mode will distort the profile).

The **Polyline Simplification** option will remove each vertex that is within a certain distance to its least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Threshold is a positive number that determines the distance under which vertices will be removed from the polyline.

The **Polyline Smoothing** option will smooth each vertex in the polyline using a least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Factor is a number between 0.0 and 1.0, 0.0 being no smoothing performed and 1.0 being fitting each vertex to its respective least squares line (usually makes the polyline extremely linear given a window size greater than 8).
If Draw Planes is enabled, plane objects that follow the path of the initial selection polyline will be drawn into the viewer after the profile is extracted.

Extract Along Centerline when clicked the user is prompted for the .CL file to use. The horizontal location of the centerline is extracted from the mesh.

After selecting your profile by manual method or .CL file, a dialog will open asking for an action to perform with the extracted profile, this gives you a chance to review the profile and the option to save it to the project, extract it, or draw it in CAD software.

If Draw in AutoCAD/IntelliCAD is selected, the program will draw the profile into your CAD application. If Save to File is selected, you will be asked for a filename and directory to place your new .PRO file. If Save to Project is selected, the profile will be added to your project with its name generated from your project settings. Profiles saved to the project may be drawn in CAD and/or exported to a .PRO file at a later time.

Prompts

Click to Begin Polyline Left-click in the viewer to create the polyline for the profile, Right-click to end the polyline.

Choose Profile Destination Dialog Select the desired destination for the file.

Tab Location(s): Action Tab
Panel and Button: Extract and Profile
Prerequisite: Open scene of a mesh

Extract Breaklines

PointCloud has an automatic breakline extracting function to help facilitate the processing of a dataset. In order to extract breaklines, you must have a mesh open in the viewer and for best results you should have it colored by normals (although this isn't required because you can manually enter in the normals). Before you can extract breaklines you must specify the area in the mesh that you wish to extract breaklines from using the selection tools. After you have selected the area from which you wish to extract breaklines, the Extract Breaklines button should no longer be ghosted out. After pressing the Extract Breaklines button a new panel should be displayed at the bottom of the Action Page which displays all the options for configuring PointCloud's breakline extraction utility. Additionally, the viewer window will remove the coloring of the current selection to prevent it from interfering with the zone flag specification process, the viewer still internally keeps track of the area of the mesh that you have selected.
To add color zones, Ctrl + Click in the 3d view window on the mesh at a location that has the color/normal you want to define your zone. This will add the color to the Color Zones table, and you can manually modify the value if it isn't quite what you want it to be. You can choose which directions you want to be considered when zone classification is being performed using the Use X, Use Y, and Use Z check boxes. Restricting directions can yield better results in certain situations. For instance, if you're trying to extract edges along a curb, it would be best to turn off Use X and Use Y and only use the Z direction of the normal to determine the zone, due to the fact that curbs are usually a corner with a vertical surface and a horizontal surface.

There are two methods of breakline extraction: By Vertex and By Face. In the vertex method of breakline extraction, each vertex of the working selection is assigned one of the zones based off the normal at that vertex. PointCloud then creates polyline vertices on each edge that connects vertices that belong to different zones. These polyline vertices are then perturbed based on how the vertex normal's compare to the normal that defines its zone. This method is the default method and generally gives better results in datasets that have hard edges (such as corners of buildings).

Simple example of the Vertex Method

The vertex method has one unique setting that does not belong to the face method: Use Local Smoothing, which averages the normal at each vertex with it's neighbor's normals to provide a smoother set of normals to work with. This helps to give more continuous breakline edges by accommodating for places in the mesh that may be distorted due to faulty data.
In the face method of breakline extraction, each face of the working selection is assigned a zone based off it’s normal. Polylines are then created out of the edges that border faces that belong to different zones. The face method also has unique options of minimum area and triangle count values for each zone area. This is to prevent a common problem with the face definition method where a single face or a small number of faces near the border will be classified as belonging to a zone other than the one they currently reside in, creating an extremely small zone.

The **Join Nearest** option will join any polylines whose endpoints are within the threshold distance of each other. This can help to bridge gaps in the mesh that could arise from parts of a scan being in shadow.

The **Polyline Simplification** option will remove each vertex that is within a certain distance to the least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Threshold is a positive number that determines the distance under which vertices will be removed from the polyline.

The **Polyline Smoothing** option will smooth a each vertex in the polyline using a least squares approximation. Window is the number of neighbor vertices to use when generating the least squares approximation. Factor is a number between 0.0 and 1.0, 0.0 being no smoothing performed and 1.0 being fitting each vertex to it’s respective least squares line (usually makes the polyline extremely linear given a window size greater than 8).

Pressing the **Show** button will show the zones in the viewer given the current configuration but not actually create the polyline themselves. This gives you a chance to review your settings and make sure that the zones are configured properly without adding any extra objects to the project.

Pressing **Extract** will extract the breaklines with the given settings. Each breakline polyline will be added to the project with the a name generated from the current project settings.
Prompts

Specify Zone Flag Position Ctrl-Click in the viewer to select the color zone for breakline extraction

Tab Location(s): Action Tab
Panel and Button: Extract and Breaklines
Prerequisite: Open scene of a mesh with color by Normal

Bare Earth

Clicking the Bare Earth button will expand the Bare Earth panel and put the Current Mode into Bare Earth mode. Settings may be adjusted as desired. When you move your cursor to the Scene window Point Cloud is ready for you to specify the "scanner" position or center of the Bare Earth extraction. The scene must be in plan view to run the bare Earth extraction. Points are examined and either included or excluded for the Bare Earth Cloud based on the extraction parameters.

There are several options that will effect the Bare Earth extraction.

Number of Slices (12-360) - This value determines the number of division of a 360 degree circle to use when extracting the Bare Earth. The default value of 36 uses 10 degrees in each slice.
Slice Vertex Limit - This is the maximum number of points that will be used in each slice. The total number of points used to generate the Bare Earth result is the Vertex Slice limit times the number of slices.
Highest Vertical Face - This value should be equal to the highest vertical feature in the ground surface plus a little extra for some tolerance. For example, if the highest vertical edge is a 6 inch curb, then you should enter something like 0.75 to capture the curb with a bit of a buffer. The program removes points that exceed the Highest Vertical Face value.
Maximum Slope % - This value should be equal to the steepest slope in the ground surface plus some extra for tolerance. For example, if the steepest ground slope is a 2:1 side slope, then use something like 60 (50% plus a 10%
buffer). The program removes points that exceed the Maximum Slope % value.

**Search Window Length** - This is how far from each data point that the program will check other data points for the Highest Vertical Edge and Max Slope criteria.

**Elevation Noise Tolerance** - This should be the expected elevation tolerance of the point measurements. For example, use 0.1 when the data point elevations are within +/- 0.1 of the target surface. The program removes data points that are isolated and higher than this elevation tolerance from their neighbors.

**Prompts**

**Specify Scanner Position:** -Ctrl-Click in the Scene window-

A default name will be provided for the new cloud being created based on the Name Conventions under Settings. You may change the name by typing in the Name field.

- ✓ - Accepts the new cloud file name and begins the Bare Earth Extraction.
- ✗ - Cancels the file creation and the Bare earth extraction.
- ? - Accesses the Bare Earth Extraction help file.

**Tab Location:** Action Tab

**Panel and Button:** Extract and Bare Earth

**Prerequisite:** Open Point Cloud Scene in plan view

---

**Scene Tab**

The **Scene Tab** allows customization of the currently active scene's drawing options. The **Scene Tab** will be blank until you open a scene from the **Project Tab** using the View command.
Each scene maintains a tree-style list of the objects it contains as well as the graphical settings for those objects. Upon first opening a scene and selecting the scene tab, the scene itself will be selected in the tree structure and the **Lights** properties of that scene will be visible. To modify the graphical properties of an object, select that object from the tree list and the properties panel will update to show the current properties for that item.

There are five types of graphical properties that an object can have:

1. Lights (which only the scene object has)
2. Vertex
3. Edge
4. Face
5. Text

If an object has more than one of these properties, then they will be arranged in a tabbed notebook style similar to how the Project Manager is organized. Aside from **Lights** properties, there exist two modes for each property type:

1. Static
2. Dynamic

These relate to the two different types of drawing modes that the Point Cloud Viewer operates in.

**Light Properties**
Lighting can be used to help enhance the visibility of changes in a surface that might be too minor to detect in certain color modes. Keep in mind that enabling lighting will sacrifice performance for this increased image clarity. There are two parts to the lighting functionality, the directional light and the ambient light.

**Directional Light**

- **Light Intensity**: Controls the intensity of the directional light, which is a light, positioned to simulate the effect of a distant light source like the sun.
- **Azimuth Angle**: Controls the angle of the directional light source with respect to the z axis.
- **Elevation Angle**: Controls the angle of the directional light source with respect to the xy plane.

**Ambient Light**

- **Ambient Intensity**: Controls the intensity of the ambient lighting, which is the base light level that affects everything regardless of the surface normal.

**Vertex, Edge, and Face Properties**

Vertex, Edge, and Face properties control how an object's vertex, edge, and face elements will be drawn. The visibility of these elements can be toggled with the *Show* checkbox, and their size can be modified in the *Size* text box. There is an additional *Show Front* and *Show Back* options for edges and faces that pertain specifically to drawing edges or faces that face towards the mesh's normal or away from the meshes normal (usually the positive z axis). The *Single* radio button allows you to give the edges/vertices of the currently selected object a solid color, instead of whatever coloring mode you might already have applied to the object. The new color can then be specified by clicking on the *Color* button. The *Smooth* option in the performance panel tells whether to enable antialiasing on the vertices or edges to make them look smoother at the cost of performance.
Comparison of a Cloud without and with Vertex Smoothing

Text Properties

The Text properties page controls how the viewer will draw an object's text elements. It contains similar controls to the Vertex, Edge, and Face controls, but also has a couple options that pertain specifically to the text's alignment. Changing the alignment will not change the origin of the text, merely how the text is displayed in relation to that origin. Additionally, some objects can have several text elements, so you will have to specify which text attribute you want to modify in the Attribute drop down box.

Camera Tab

The Camera Tab is the third tab in the Project Manager and has several functions that govern the current scene’s camera behavior and positioning as well as functions that allow access to some camera presets. The Camera Tab will only be active if there is a currently open scene, otherwise all of its controls will be ghosted out.

The Mouse Motion Panels

The Left Motion, Middle Motion, and Right Motion panels control the behavior of the left, middle and right mouse buttons, respectively.

Cube Orbit rotates the camera around the center of the scene's bounding box, the default behavior for the left mouse button.

Orbit will orbit the camera around the pivot, and the pivot's behavior can be defined in the Pivot panel.

Pan pans the camera, moving the camera laterally or vertically from its perspective, the default behavior for the
middle mouse button. 
**Swivel** rotates the camera view direction around its current position. 
**Zoom** will zoom the camera, moving the mouse up will zoom in, moving the mouse down will zoom out. This is the default behavior for the right mouse button.

## The Zoom Panel

The **Zoom** panel has some buttons that relate to the camera's zoom levels.

![Zoom Panel](image)

- **Window** will allow the user to draw a window in the current top-level viewer in which the zoom level will be adjusted to fit that window.
- **Extents** will move the camera out from the scene so that the entire scene fits in the current view given its view direction and projection settings.
- **Reset** will reset the camera to the default seen upon initial loading of the scene.

## The Current Camera Panel

The **Current Camera** panel has options for manually modifying each of the camera's position and view direction properties. Each option features a target button which, when pressed, will allow you to ctrl click into the scene to set that property to a value from the scene. The preset views for the Camera are accessed by clicking the icons along the top of the panel. From left to right they are; Top, Bottom, Front, Back, Left, Right and Scanner location.

![Current Camera Panel](image)

- **Eye** is the position of the current camera.
- **Target** is the current facing direction of the camera.
- **Up** is the current camera's up vector.
- **Normal** is the 90 degree vector to the current view plane.

## The Pivot Panel

The **Pivot Panel** determines the behavior of the pivot point when in **Orbit** mode.

![Pivot Panel](image)
Automatic, the default behavior, moves the pivot to the valid data nearest to the cursor whenever orbit mode is activated.
Center will move the pivot point to the center of the scene's bounding box.
Custom will enable the Position controls and allow entry of the Pivot point manually (or via a ctrl-click in the scene if you press the green target button).
Origin will move the pivot point to the origin of the scene's coordinate system.
Target will place the pivot point at the nearest valid data to the center camera's view.

The Projection Panel

The Projection panel determines the projection mode of the current camera.

Orthographic projection mode will not apply perspective distortion (to simulate the effect of a real-world camera lense) and the View Height option will determine the height of the view (in world units).
Perspective projection mode will apply a perspective distortion, and the Field of View option determines the vertical viewing angle of the cone that defines the camera's visibility.

The Clipping Panel

The Clipping options allow the user to manually set up of the view's clipping planes. Clipping planes will cut out any objects closer than the front clip plane and any objects further than the back plane. In some cases, it may be useful to manually manipulate the clip planes. By default custom clip planes are disabled.

Center will treat the front and back plane distances as distances from the center of the scene, so the front clip plane is placed Front units away from the center in the direction of the camera and the back clip plane is placed Back units away from the center in the direction opposite of the camera. Eye will treat the front and back plane distance as distances from the current camera's position, in this mode, Front should be larger than Back or nothing will be drawn on screen. Origin will treat the front and back plane distances as distances from the scene's origin, typically this option is only used when working with a scan whose coordinate system places the scan at the origin. Pivot will treat the front and back plane distances as distances from the current pivot point. Target will treat the front and back plane distances as distances from the valid point nearest to the center of the screen.

Camera Actions

Additionally, there is an option to save the current camera settings to the current scene (which can later be accessed through the scene page) using the Save Camera button and an option to save an image of the current contents of the viewer using Save Screen, which will bring up a save file dialog. Pressing Save Screen will bring up the standard Carlson save file dialog and you can choose where to save the image as BMP file. The final option is to Save to PDF. Pressing the Save to PDF button opens the PDF options. The user can choose size of image, Border and title block fields to be included in the PDF file. The current view in the scene is written to the PDF.
Data Tab
The PointCloud Data Page is useful for visual inspection of data in the current scene without actually creating objects. It allows the user to examine, color, range, and position values in the scene's coordinate system as well as in coordinate systems relative to the scanner positions or a reference point.

By default, all data inspection is done in the scene's global coordinate system. However, it is also possible to work in coordinate systems relative to the scanner positions by clicking the Local radio button and choosing a scan position to use as basis for the coordinate system.

The Object panel displays the name and object type of the current object under the cursor.

The Model Coordinates panel displays the Cartesian coordinates (in the currently selected coordinate system) of the point under the cursor if it is a valid data point.

The Polar Position panel displays the current polar coordinates of the point under the cursor if it is a valid data point.

The Color panel displays the color values of the pixel under the cursor, if valid. Keep in mind that this value will not be the exact color value of the dataset if lighting is enabled of it the object under the cursor is selected.

The Reference Point panel displays options for placing the reference point and information about the point under the cursor's relative position to the reference point. This is useful to rough estimation of range values without have to create a polyline in the project. Clicking the small green target icon will put the current viewer into reference point positioning mode, and a Ctrl-Click in the viewer will place the reference point at the valid data nearest to where you click.
Data Objects

There are several data types in Carlson PointCloud. These items are organized into a tree structure and each can be manipulated by right clicking to bring up a menu specific to that item type. Depending on the complexity of the selected object, a menu may not pop up or a menu with several options may pop up.

Common Functions

There are several functions that are shared among several object types. For brevity, these functions are listed here.

Object Action Panel

In every function that can manipulate a dataset (cleaning, simplifying, etc), the topmost set of options in the dialog for that function consists of options for the results of the change.

Modify Existing will modify the current underlying object in the project, while the Create New will add a new object to the project in the same folder as the object being manipulated, with the Name option specifying the name of the new object.

Copying an Object

If an object has external data, such as a cloud, scan, or mesh, it may be useful to preserve the original data in case changes are made to it that are unrecoverable. Selecting Copy will bring up the copy object dialog.

The new item will be added to the same folder as the source item, with the name chosen.

Removing an Object

If an object can be removed from the project, there will be a Remove option in the right-click menu for that object. If the object has external files (scans, meshes, and clouds) you will be prompted with what action to take with the external file.

Renaming an Object

To rename an object, right-click it and select Rename. If you try to assign that object a name that already exists elsewhere in the folder that object is in, PointCloud will revert the change back to its old name.

Viewing an Object

If an item has data that can be viewed (in either two dimensions or three dimensions), there should be a View option in that objects right-click menu for that object. Upon clicking View, the View Object dialog should be displayed.
The **Action** panel determines whether to create a new scene for that object or to add the object to a scene that already exists. If **Append to existing** is selected, the list in the options panel will become enabled to allow selecting the target scene, with **Create new** selected; the name in the **Name** panel will determine the name of the new scene. The **Mode** panel determines the dimensions to view the data in. Viewing the data in **2D** mode will only be available if the dataset can be laid out on a two dimensional plane (scans, profiles, and images). Additionally, selecting **2D** mode will not add a new scene to the project, it will only create a temporary scene to view the data in, as there is no reason to view multiple objects in the same 2D view (the objects would all obscure each other). The **Color** panel determines the mode to color the data in, of which there are eight modes that will be available depending on the data in the target object and the mode it will be drawn in. These color modes are divided up into categories based on how the colors are determined, these categories are: **Simple** colors the entire dataset the same color, **Position** colors each point based off its world positioning data, **Intensity** colors each point based off of its single intensity value, **Direct** colors the points based off their color information.

The **Simple** category only has the **Direct** color mode which colors the entire dataset a single color, which can be chosen in the Scene tab of the Project Manager.

The **Position** color category has three color modes: **Elevation** which colors each point in a range from blue being the minimum elevation value to red being the maximum color value, **Range** which colors each point based off its distance from the origin (or scanner if the current object being viewed is a scan), black being the minimum distance and white being the maximum, and **Normal** which colors each point based of the normal of the surface at that point. In the **Normal** mode, each color dimension (red, green, and blue) are assigned a spatial dimension (x, y, and z) to represent that direction in the objects finally color.

The **Intensity** color category has three color modes: **Direct** will color each pixel in the range from black to white based off its intensity value, **Scaled** will scale the range of intensities so that the minimum intensity in the data set matches up with zero and the largest intensity in the data set will match up with the maximum possible intensity value, which can make minor changes in intensity more noticeable, and **Equalized** will perform a similar scaling operation but do it in a manner that will equalize the histogram of the intensity values, making it so that all intensity values occur equally often, this method can also make minor changes in the intensity much more noticeable.

The **Color** color category has two color modes: **Direct**, which colors each point directly by its internal color value, and **Grayscale** which colors each point by the grayscale representation of its internal color value.

In addition to the above method of scene creation, you may also create a scene by right clicking the scenes folder.
and selecting **Create New** from the menu. This method will allow you to create a scene with multiple objects in it without having to go through the dialog several times.

The right half of the dialog is the same as single object viewing, but the left half of the dialog shows a tree structure representing objects in the project that can be added to the scene. Click on the red x icon next to an object to toggle inclusion of that object in the scene.

When viewing any of the large object types (scans, meshes, and clouds) there is only one copy of that object retained in memory at all times. This is done to preserve memory as much as possible when opening up multiple views of the same object. This also means that any changes made to the object in one view will be reflected in all other views of that object. For instance, if you're viewing a scan in two views and wish to clean up its data, deleting points from the scan in one view will change the scan in any other views of it. When all views of an object have been closed, the object modified dialog will be displayed prompting the user for an action to perform with the modified data.

This dialog is very similar to the action panel found in many other dialogs. **Modify existing** will save the changes to the original object and **Create new** will allow the user to specify a name for a new object of that type with the modified data. **Discard Changes** will close the scene without saving changes.

**Drawing an Object to CAD**

If an object can be drawn to the CAD engine that PointCloud is running alongside, there will be a **Draw** option
in the right-click menu for that object. Clicking **Draw** will bring up the standard Carlson layer selection dialog. Objects will be drawn in their current coordinate system (if two scans are properly registered, they will be properly aligned with each other when drawn to the CAD engine).

### Basic Project Items

#### Points

There are three kinds of point item types in Carlson PointCloud: control points, target points, and coordinate points. **Target points** always exist as a sub-item of a scan position and are in that scan position's local coordinate system. This means that a project can have several sets of target points (one for each scan position).

**Control points** are the global positions of the target points, and are a sub-item of the **Instrument Data** folder. There can be only one set of control points for a project.

**Coordinate points** are points extracted from the final registered data sets and are a sub-item of the **Processed Data** folder. Coordinate point positions are in whatever coordinate system the data the extraction is performed from is in.

All point types have the same right-click menu options.

#### Polylines

Polylines are usually extracted from the registered data, but they can also be imported or manually entered with the **Import** and **Edit** commands. Polyline importation is very similar to importing a set of points; see the documentation for data points for more information. The edit brings up the Point Editor; see the documentation on the point editor for more information.

#### Reflectors

Reflectors in a PointCloud project represent a disk, sphere, or cylinder reflector within the set of scans for the current project. Each reflector can be linked to a control point which will enable PointCloud to account for the shape of target points that are to be linked with that control point during the scan registration process.

These reflectors can either be imported from an ASCII text file with the **Import** command or entered in manually with the **Edit** command. Pressing **Edit** will bring up the point editor dialog with some specialized options for reflectors.

The only difference between this point editor and the one used for the various point objects is that the **Add Reflector** button will bring up a different dialog that allows you to specify the properties of the new reflector.
Name will specify a unique name to be used for the reflector in the registration process. Shape is a dropdown with three options relating to the three reflector shape types (disk, cylinder, and sphere). Diameter allows you to specify the diameter of the sphere, cylinder, or disk objects. Height is accessible only for the cylinder reflector type and specifies the height of the cylinder.

After all the reflectors have been added to your project, linking them to their corresponding control points is done through the control points editor. See the documentation for the Point Editor for more information.

Images

Images are stored in a folder as a sub-item of a scan position. There can be multiple images per scan-folder, and typically are pictures taken from the position of the scanner. Images can only be viewed in 2D mode.

Coordinate System

The Coordinate System is the current transformation applied to a Scan Position. This transformation is applied to any scans that belong to the current scan position. Typically, manual modification of the coordinate system should not be necessary, as the proper coordinate system to align scans properly should be determined during the registration process. To modify the coordinate system for a scan position, right-click it and select edit. This will bring up the Coordinate System editor.

The transformation panel displays the transformation matrix that is applied to the scan position. The three buttons along the bottom are Register Scan Position, Import, and Export, from left to right. See the documentation on the Point Editor for information about these functions.

Contours

A contour item consists of several contour polylines that have been extracted from a mesh. Contour objects can only be viewed in 3D mode and drawn to the CAD engine. Contour extraction is done through the Action Tab, for more information on how to extract contours, see the documentation for Extract Contours in the Action Tab.
Grids

Grids are rectangular representations of a cloud typically used to instead of TIN. The grid file that is created by Point Cloud has a PCG extension. Point Cloud grids are saved to the Grids folder under Processed Data in your project folder. To share grids created in Point Cloud with other Carlson modules right-click the grid you want and select export. A GRD file will be exported. Grids created in other Carlson modules can be imported into Point Cloud by right-clicking Grids and selecting Import. For more information on how to create a grid, see the documentation for Create Grid in the Action Tab.

Profiles

A profile consists of a set of height values and distances taken along a polyline extracted from a mesh. Profiles can be viewed in 2D and 3D mode and drawn to the CAD engine. Additionally, profiles can be extracted to the .pro file format. Profile extraction is done through the Action Tab of the Project Manager. For more information on how to extract profiles, see the documentation for Extract Profile in the Action Tab.

Sections

A section object consists of a list of profiles taken at certain distances along a polyline. Sections can be extracted from a mesh using the Action Tab in the Project Manager. Sections can only be viewed in 3D mode and can also be drawn to the CAD engine. Additionally, sections can be extracted to the .sct file format. See the Extract Section documentation in the Action Tab for more information about how to extract sections.

Scenes

Scene objects maintain a list of objects that are in the scene, graphics properties for those objects, and camera information for the scene. If a scene is closed and then reopened, these properties should still be the same.

Instrument Data Project Items

There are two data types in Carlson Point Clouds. These are Instrument Data and Processed Data. Within each data type there are various items and objects that can be added, edited or created. These Data types and items are organized into a tree structure and each can be manipulated by right clicking to bring up a menu specific to that item type. The menu options presented when an item is right-clicked will depend on what the item is. The data types listed here are specific to Instrument Data. Common functions can be found in the Data Objects section.

Points

There are three kinds of point item types in Carlson Point Clouds:

- Control Points
- Target Points
- Coordinate Points

Coordinate Points are processed data and are discussed in the Processed Data section.

Target points always exist as a sub-item of a Scan Position and are in that scan position's local coordinate system. This means that a project can have several sets of target points (one for each scan position).

Control points are the global positions of the target points, and are a sub-item of the Instrument Data folder. There can be only one set of control points for a project.

Reflectors

Reflectors in a Point Clouds project represent a disk, sphere, or cylinder reflector within the set of scans for the current project. Each reflector can be linked to a control point which will enable Point Clouds to account for the shape of target points that are to be linked with that control point during the scan registration process.
These reflectors can either be imported from an ASCII text file with the **Import** command or entered in manually with the **Edit** command. Pressing **Edit** will bring up the Reflectors editor dialog box.

Below is a list of the Reflectors Editor options.

- **New Reflector** brings up a dialog that allows you to specify the properties of a new reflector to add.

New Reflector dialog box showing:
- **Name** will specify a unique name to be used for the reflector in the registration process.
- **Shape** is a dropdown with three options relating to the three reflector shape types (disk, cylinder, and sphere).
- **Diameter** allows you to specify the diameter of the sphere, cylinder, or disk objects.
- **Height** is accessible only for the cylinder reflector type and specifies the height of the cylinder.

- **Edit Selected Reflector** brings up the Reflectors edit dialog which allows you to change properties of the currently selected reflector.

- **Delete Selected Reflector** deletes the currently selected reflectors.

- **Import Reflectors** brings up the ASCII file import dialog.

- **Export Selected Reflectors** brings up the ASCII file export dialog.

- **Settings** allow you to configure what properties of the reflectors are visible in the spreadsheet control.

- **Help** brings up help documentation.

After all the reflectors have been added to your project, linking them to their corresponding control points is done through the Control Points Editor.

**Coordinate System**

The Coordinate System is the current transformation applied to a Scan Position. This transformation is applied to any
scans that belong to the current scan position. Typically, manual modification of the coordinate system should not be necessary, as the proper coordinate system to align scans properly should be determined during the registration process. To modify the coordinate system for a scan position, right-click it and select View. This will bring up the Coordinate System editor.

The transformation panel displays the transformation matrix that is applied to the scan position. The three buttons along the bottom left are:

- **Register Scan Position** Four registration methods are available; Use existing references, Match point names, Match point descriptions and Minimize point position error. If you select Minimize point position error, the Registration Settings panel will activate and you can set Maximum Error, minimum References and toggle Update target point names and Update target point descriptions
- **Import** brings up the import dialog box.
- **Export** brings up the export dialog box

**Images**

Images are stored in a folder as a sub-item of a scan position. There can be multiple images per scan-folder, and typically are pictures taken from the position of the scanner. Images can only be viewed in 2D mode.

1. **Right-Click Images** in the project tree.
2. Select **Add → Existing**.
3. Select an existing image to add to the current Point Clouds project.
The Files panel specifies the Source and Target location for the image file selected.

The Action panel allows the user to choose to copy the selected image to the target location or move the selected image. Moving the image will delete it from the source location and it will only be available in the target location.

The If target file exists panel determines what to do if the file name of the image being added already exists in the project folder.

Target Points

Target points always exist as a sub-item of a Scan Position and are in that scan position's local coordinate system. This means that a project can have several sets of target points (one for each scan position). There are two ways to manipulate Target Points:

1. The Right-Click menu
2. Target Point Editor

- **Edit**
  - Launches the Target Points Editor
- **Delete All**
  - Deletes all Target Points. The user is prompted via a dialog box to confirm the deletion.
- **Import**
  - Launches the ASCII file import dialog box.
- **Export**
  - Launches the ASCII file export dialog box.
- **Transform**
  - Launches the Transform dialog box to allow the user to define a transformation sequence to apply to the target points.
- **View**
  - Launches the Scene creation dialog box to create a scene for viewing the target points.
- **Draw**
  - Draws the Target Points in CAD. The user is prompted via a dialog box for the layer to draw the Target Points on.

Notes:

Several commands are available in both the Right-Click menu and in the Target Points editor. The difference between a command in the Right-Click menu and in the Target Points editor is the Right-Click menu commands operate on all target points. The Target Points editor commands operate on only the selected Target Points. If no target points are selected the users is asked if they wish to perform the operation on all target points.
The Target Point Editor is activated when the user right-clicks Target Points and selects Edit. In the Target Point editor there are several base functions that are shared across all point types.

The title bar will display the scan position that the target points are part of. Just below that is a toolbar with several icons. The icons and their corresponding functions are as follows:

- **Activate Target Point** toggles the selected target point(s) to be active in the current project.
- **Deactivate Target Point** toggles the selected target point(s) to be inactive in the current project.
- **Add target Point** brings up a dialog that allows you to specify the properties of a new target point to add.
- **Edit Target Point** brings up the target point edit dialog which allows you to change properties of the currently selected target point.
- **Copy Target Points** allows you to copy the currently selected points to another point set (such as from the target points to the control points of a scan).
- **Delete Target Points** deletes the currently selected target points.
- **Import Target Points** brings up the ASCII file import dialog.
- **Export Target Points** brings up the ASCII file export dialog.
- **Transform Target Points** allows you to define a transformation sequence to apply to the target points.
- **View Target Points** brings up the scene creation dialog for viewing the current target point set.
- **Register Scan Position** begins the scan registration process for the current set of target points.
- **Coordinate System** allows you to choose the coordinate system the positions values are in (Global or any current scan positions)
- **Settings** allow you to configure what properties of the points are visible in the spreadsheet control.
New Target Point

Name will specify a unique name to be used for the Target Point in the project. X, Y and Z may be in feet (ft) or Meters (m). These are the coordinates of the Target Point. Description allows you to optionally add information that describes the new Target Point. Control Point allows the user to specify a Control Point for the new Target Point.

Import Target points
The settings of the import dialog must be configured to match the data ordering of the file being imported. First, ensure that the **Delimiter** is set to the correct value, if it is there should be multiple columns in the dialog, if it isn't, all of the data should only be in one column. After the delimiter is properly set, the data values for each column must be set. This can be done by clicking the header of each column (which say *Click to Set* by default) to bring up a menu with all the available values that can be set for that column. After setting these values toggle the importing of lines you wish to leave out by clicking the green buttons in the Import column to turn them red. At the top of the dialog is the presets panel, which will allow you to save the current settings if you wish to use them again later. After configuring the dialog to match your data, click the green check to import and continue to the next step. The next dialog displayed will allow you to configure the naming conventions for the target points to be imported.

Selecting **Rename all items** will rename all imported points to the settings specified in the options. The **Duplicate Entries** panel will specify the action to take when a point being imported has a name that already exists in the set of points being imported to. If the **Rename all items** toggle is not selected the names listed in the file being imported will be used. If there are no names in the file being imported and **Rename all items** is not selected, the control points will be named using the settings in **Project Settings** naming conventions.

### Exporting Target Points

Clicking the export button will bring up the Export Target Points dialog, which will allow you to export the data to several different file formats.
Simply click the check boxes next to the data elements that you wish to export. To change the order of the data elements in the file, select the data element you wish to move and click the up or down arrow to move it. The **File** panel determines which file format to export to and also allows you to specify an extension other than the default for a given file format. The **Text** allows you to specify the **Delimiter** to be used as the divider between data elements in the file and whether to use the **Write header** to specify whether to write a header line to the file detailing the data ordering of the file.

### Transform Target Points

The Transform Target points dialog box allows specifying a sequence of transformations to apply to the currently selected target points.

Initially the transformation list is empty. Press the green plus button to add a new transformation, which will bring up a new dialog.
There are three types of transformations, as well as an advanced transformation where the user can specify the transformation matrix to apply.

1. **Translation** transformations move the points linearly along the offset values specified.
2. **Rotation** transformations rotate the points around the axis specified the angle specified.
3. **Scaling** transformations scales the selected points (using the global origin as the origin for the scaling) in each dimension by the amount specified.

After the transformation’s settings have been configured, pressing the green check mark will add it to the current list of transformations. In the Transformation sequence dialog the following functions apply:

- ![Translation](image1.png) Will allow you to edit the currently selected transformation.
- ![Delete](image2.png) Will delete the currently selected transformation.
- ![Order](image3.png) Will change the order of applications of the transformations. Transformations are applied in top-to-bottom order.

**Register Scan Position**

The **Register Scan Position** button will launch the Register Scan Position dialog box.
There are four registration methods; Use existing references, match point names, Match point descriptions and Minimize point position error. The **Registration Settings** are used with Minimize point position error only. The settings are grayed out for all other methods. Click the green check mark to register the target points. Once registration is successful you can check the results in the Edit Target Points dialog. The data displayed is controlled by the options selected in settings.

**Settings**

The Settings button will bring up the Point Editor settings dialog, which will allow the user to configure which data elements of the current point set are visible, as well as the order that they are displayed in.

Display of a property can be changed by toggling the check box next to that property, changing the order can be done by first selecting the property to move and then pressing the green up or down arrows to move the selected property up or down. Saving the current settings can be done clicking the plus button in the **Presets** panel.

**Tab Location(s):** Project Tab  
**Panel and Button:** Current Project and Target Points  
**Prerequisite:** None
Clouds are the most basic of the three large dataset objects supported by Carlson Point Cloud. Clouds always consist of a set of positions and can also contain color, intensity, and normals associated with each point. Point Cloud has several functions that can help reduce, clean, and generally prepare Clouds to be manageable in a CAD application. In the project's tree structure, clouds are categorized under Processed Data in their own folder, Clouds. In addition to the general actions common to most of the other data elements with 3D data, such as view, Clouds have a couple of unique functions that make them distinct from other data objects.

Importing a Cloud

To import a cloud from an ASCII file bring up the right-click menu for the Clouds folder and select import. This will bring up the list of supported formats.

- DEM
- FARO
- Generic ASCII
- Leica
- LIDAR
- RIEGL
- TerraScan
- Topcon

Selecting one of the formats will open the standard Carlson file selection dialog and after the file has been selected, the Import Cloud dialog will be displayed.

Here, the user must define what delimiter was used for the ASCII file, if the data not organized properly in columns (all the data is in one column for example); the delimiter will probably need to be changed. Clicking the header of each column will bring up a menu with all the possible values that can be assigned to it, click each column's header to set its proper value. At the top of the dialog is the Presets Panel, which allows you to save the current column assignments to be used in the future. The import column is used to determine whether to import that particular column (often files will have text or header information that isn't actually part of the data set). Save the current configuration by clicking the + button in the panel, presets can also be removed by clicking - button. Presets are
Creating a Cloud

There are several methods for creating a cloud, but all of these methods use one of two cloud creation dialogs. The most common and direct method of creating a cloud is to right-click the source data object (either another cloud, a mesh or a scan) and select Create Cloud. This dialog operates in two different modes: multiple source mode and single source mode.

Single Source mode is typically the result of right-clicking a data object in the Point Cloud tree structure and selecting Create Cloud, this mode only allows the cloud to have the object that was selected as its source.

Multiple Source mode is only accessible by right-clicking the Clouds folder itself and selecting Add New in the menu. In this mode, the user will see a tree structure that represents the project on the left side of the dialog. You can toggle inclusion of any object in the project by clicking the x icons next to them to turn them green. The right side of the dialog works the same as in single source mode.

Cleaning a Cloud

Right-click the Clouds folder and select Clean to open the Clean Cloud dialog.
The **Clean** function will attempt to clean up the data in a cloud through two different methods, either of which can be disabled.

**Remove Duplicated Points** method will search for any places where two or more points in the cloud are within the **Distance threshold** of each other. If any such points are found, they are deleted from the cloud. This method is to help remove redundant data that for all intents and purposes are the same given the current data set (say a data set that spans several miles having two points within inches of each other) and reduce the size of the data set.

**Remove Isolated Points** method will search for any points in the cloud that have less than **Minimum Neighbors Count** points within **Distance Threshold** units from them and delete them. This will remove points that are likely to be outliers, which could be a result of bad data (such as the scanner hitting a dust particle several meters off the ground). After clicking the green check button, the cloud cleaning process will begin. The time required to clean a dataset varies depending on the size of the dataset.

**Resampling a Cloud**

Point Cloud has two methods of cloud reduction. There is a fast, naïve method, and a slower, more intelligent method. Right-clicking a cloud and selecting **Resample** will bring up the **Resample Cloud** dialog.
Step method is much faster at the cost of being less intelligent. It will simply reduce the cloud to $1 / \text{Step}$ its current size by only keeping one out of every $n$th vertices. So in the case of a step size of four, it will traverse the cloud and only keep every fourth vertex, deleting three for each one it keeps.

OC-Tree tree method is much more intelligent, but it can have significantly longer run times than the step method. It divides the bounding box of the cloud into blocks defined by the resolution size and then filters out points based on the minimum and maximum parameters. If a block has less than the minimum number of points, its contents will be deleted, if a block has more than maximum points, random points within that block will be removed until it has maximum points inside it.

**Tab Location(s):** Project  
**Tree Folder:** Clouds  
**Prerequisite:** Existing Cloud, Mesh, Scan data or ASCII file

## Processed Data Project Items

There are two data types in Carlson Point Clouds. These are Instrument data and Processed data. Within each data type there are various items and objects that can be added, edited or created. These Data types and items are organized into a tree structure and each can be manipulated by right clicking to bring up a menu specific to that item type. The menu options presented when an item is right-clicked will depend on what the item is. There are several functions that are shared among multiple object types. These common functions are discussed under Data Objects. This section deals with Processed Data objects. The following data types are considered Processed Data:

- Clouds
- Contours
- Coordinate Points
- Grids
- Layers
- Meshes
- Planes
- Polylines
- Profiles
- Sections
Clouds can be created several ways and can contain up to one billion points.

1. You can right-click a scan and select Create > Cloud.
2. You can right-click Clouds and select Add > New.
3. You can right-click Clouds and select Add > Existing.
4. You can right-click Clouds and select Import.

Contours

A contour item consists of several contour polylines that have been extracted from a mesh or cloud. Contour objects can only be viewed in 3D mode. Contour objects can be drawn to the CAD engine. Contour extraction is done through the Action Tab of the project manager.

Coordinate Points

There are three kinds of point item types in Carlson Point Clouds:

1. Control Points
2. Target Points
3. Coordinate Points

Control Points and Target Points are Instrument Data and are discussed in the Instrument Data section.

Coordinate points are points extracted from the final registered data sets and are a sub-item of the Processed Data folder.

Grids

Grids are a rectangular representation of a TIN. They are created from Cloud scenes or imported. For more information about creating Grids see Create Grid under the Action Tab

Layers

Layers allow the user to control visibility and color for entities drawn in the Point Cloud scenes. For additional information see Layer Properties Manager under Common Utilities.

Meshes

Meshes are used to extract profiles, sections and can be exported as TIN files for use with other Carlson modules. For more information about meshes see Meshes under Processed Data.

Planes

Planes may be created as part of the process of extracting Contours, Sections and/or Profiles. Planes may also be created by right-clicking Planes on the Project tree and selecting Add > New. Planes created from the Project Tree will likely need to be edited to establish location and normal direction. To edit a Plane double click it in the project tree or right-click it and select edit. Planes created by extracting data can also be edited.

Polylines

Polylines are usually extracted from the registered data working through the Action tab, but they can also be imported or manually entered with the Import and Add commands. If you Add a polyline it will appear under Polylines in the project tree. To edit the new polyline you can double click it or right-click it and select Edit.
Polyline > Import opens the file selection dialog. Users can select TXT, PLN or CL files to import. The Edit option brings up the Polyline Editor; see the documentation on the Polyline Editor for more information.

Profiles

A profile consists of a set of height values and distances taken along a polyline extracted from a mesh. Profiles can be viewed in 2D and 3D mode and drawn to the CAD engine. Additionally, profiles can be extracted to the .PRO file format. Profile extraction is done through the Action Tab of the project manager.

Sections

A sections object consists of a list of profiles taken at certain distances along a polyline. Section extraction is done using the Action Tab in the project manager. Sections can only be viewed in 3D mode and can also be drawn to the CAD engine. Additionally, sections can be extracted to the .SCT file format.

Scenes

Scene objects maintain a list of objects that are in the scene, graphics properties for those objects, and camera information for the scene. If a scene is closed and then reopened, these properties should still be the same.

Scans

Scans represent the raw data taken from a scanning device. In addition to the position, intensity, color and normal values found in a cloud it also maintains a scanner position, a mapping of scanner pixels to points in the cloud, and a mesh structure that creates each point in the scan with its neighbors. Each scan is associated with one scanner position, which defines the location of the scanner when the scan was taken.

Scan Positions

A scan position encapsulates the entirety of the information needed to match scans taken from a single position with the control points of a project. This data includes any scans taken from that position, the target points associated with that position, any images taken from that position, and the current coordinate system for that scan position.

Importing a Scan

Point Cloud supports the fls, 3dd, and ASCII text file formats. To import a scan, right click the scan folder of the scan position for which you wish to import the scan and click import. You will be then shown the standard Carlson file-selection dialog, if you select an fls or 3dd file, the file will be converted to Point Cloud's internal format and saved to the project. If a txt file is selected, the Import Scan dialog will be displayed.
The settings in this dialog must be configured to match the properties of the scan being imported. The first thing to do is verify that the correct delimiter is being used, if all the data is compressed into one column in the table, it's likely that the wrong delimiter is set. Clicking the header of each column will bring up a menu with all the possible values that can be assigned to it, click each column's header to set their proper values. Typically these values can be found in the header of the text file or in a file accompanying the text file. The Scan Pattern options determine the ordering method of the scan's data, as well as the starting corner of the scan's data, the data for these values can often be found in the same place as the scan's resolution information, but if not, the default, or the default with the starting corner set to Top Left are the most common scan pattern types. At the top of the dialog is the Presets Panel, which allows you to save the current column assignments to be used in the future. The import column in the table determines whether or not the row should be imported. In the example image above, we would want to click the green circle next to the first row to turn it red to avoid importing junk data (such as the header line).

**Importing Target Points**

Target points can be manually entered or imported via a similar process to scan importing. To enter the target points in manually, right-click the target points object belonging to the scan position you wish to modify and select Edit. This will bring up the Edit Points dialog for the target points.

**Registering Target Points**

The scan registration process begins with pressing the Register button in the toolbar of the Target Points Editor.
Carlson Point Cloud supports four different methods of scan registration. **Use Existing References** will make Point Cloud only use the references that already exist to perform the registration process (these references can be set manually in the Points Editor, or could have been set in a previous registration process). **Match Point Names** will match target points up with control points with the same name. **Match Point Description** will match target points with control points with the same description. **Minimize Position Error** will attempt to automatically transform the current target points so that they match up with the control points, creating control point-target point pairs. If such a transformation that meets these conditions exists, the target points will have their reference control points set to the control point they were paired with. After pressing ok, a dialog will display informing the user if the registration was successful. After all scans have been registered, the best thing to do is verify that they're all registered properly by viewing them in the same scene and verifying that surfaces look similar where the scans overlap.

**Creating a Scan**

Unlike clouds and meshes, scans can only be created from other scans. This is due to extra information required for the indexing of the cloud data into the scanner's image. To create a scan from a single source scan right click the source scan and select **Create &rArr; Scan**.
Typically, the default options give the best results. **Scan Dimensions** determines the height and width (in angles) of the new scan to create. **From Scan** will just use the ranges from the original scan and **Specify** will allow the user to specify their own custom angles. **Scan Resolution** determines the data density of the new scan, smaller **Delta Angle** values will give denser data, while larger resolutions values will do the same. The **Scan Averaging** determines the action to be taken when it is found that multiple scan points in the source data set fall under the same scan pixel in the new scan data set. **Average All** will average all color, position, and intensity values, throwing out the original data, while **Use Farthest** will only use the data point furthest form the scanner and throw away all other data points.

To create a scan from multiple source scans right click the scan fold where you wish to create the new scan and select **Add &rArr; New**.

All of the options on the right side of the dialog have the same functionality as the single source dialog. The tree structure on the left side of the dialog allows the user to choose the source scans to use for data. Clicking the red x next to a scan will turn it into green circle, signifying to use that scan as a data source.

**Cleaning a Scan**

To clean up scanner data to make it more uniform and remove possible outliers, right click the scan you wish to clean and select **Clean** from the menu.
Carlson Point Cloud has three separate methods of cleaning scans. The first of these methods is **Remove Isolated Points**, which searches all neighbor data points within a square with a side length of **Search radius** pixels around each pixel in the scanner image for valid data, if less than the maximum amount of valid neighbors specified is found, the point is deleted. The **Smooth Spikes** method reduces spikes in the mesh by finding any points whose distance from the scanner is larger than **Spike threshold** standard deviations from the average of the pixels in the search radius. The **Fill gaps** method searches each invalid point's neighbor's for the specified amount of invalid neighbors if less than the specified amount is found, then the invalid reading is changed to a valid reading with a range equal to the average of the neighbor points and color values equal to the average color values.

**Resampling a Scan**

To resample a scan, right click on the scan you wish to resample and select **Resample**.
The **Step** method of resampling steps through the scan using the step values provided for the step size. With a **Theta** and **Phi** value of 2 each, the scan will be reduced to 1/4th of its original size. The **Grid** method is somewhat more intelligent and divides the scan up into a grid where each grid block is of the specified size. It then averages the values found inside each block to a new single value for that entire grid block.

**Tab Location(s):** Project Tab

**Prerequisite:** Scanner Data

### Meshes

Meshes are the final result of processing a scan or cloud and are the basis upon which most data extraction is performed. The mesh structure itself is a set of vertices and a set of edges and faces that connect those vertices as well as any color or intensity values that were in the cloud or scan that the Mesh was created from.

### Importing a Mesh

One can import a .tin file simply by right-clicking the **Meshes** folder and selecting **Import** and navigating to the .tin on disk.

### Creating a Mesh

There are several methods for creating a mesh, but all of these methods use one of two cloud creation dialogs. The most common and direct method of creating a mesh is to right click the source data object (either another mesh, a cloud or a scan) and select **Create &rArr; Mesh**. You can also access the Create Mesh dialog form the **Action Tab**. Creating a mesh from another mesh will re-triangulate the points in that mesh based on the new normal information provided in the **Create Mesh** dialog, so it is entirely possibly that your new mesh can look completely different.
This dialog operates in two different modes: multiple source mode and single source mode. The single source mode is typically the result of right-clicking a data object in the PointCloud tree structure and selecting **Create Mesh** or from the **Action Tab**, this mode only allows the mesh to use the originally selected data as its source. **Use filters** determines whether or not to filter out vertices based on any filters applied to the source object. The **Normal** is the direction to use for the Delaunay mesh triangulation; typically you want to use an axis that is representative of the direction that the data was taken from, such as the view direction of the scanner. In the case of scans, there will be a **From Scan** radio button that you can use, which will automatically use the scanner position information from the scan as the normal. The **Mesh Faces** panel allows you to set restrictions on the meshing process. No edge in the mesh will be created if it will exceed the **Maximum edge length** or if the angle between the two faces it connects exceeds the **Maximum incident angle**. **Mesh Vertex Limits** specify the maximum number of mesh vertices that will be used in a mesh. Setting this value too low may result in no mesh being created. One can also create a mesh with multiple sources by right-clicking the **Meshes** folder and selecting **Add &rArr; New**, this will bring up a dialog similar to the one above with an extra tree control to the left.
All of the controls on the right half of the dialog are the same, but you can now toggle inclusion of objects into the mesh by clicking the red x next to their name in the tree, turning the icon to a green circle.

**Mesh Simplification**

Simplifying a mesh is one of the key ways to reduce data down to a state that it can be transferred over to CAD software or to make it more manageable in PointCloud without losing much surface quality. Right-click the mesh to simplify and select **Simplify**. This will open the **Simplify Mesh** dialog.
There are two methods of mesh simplification available. The **Elevation Difference** method will loop over all the vertices in the mesh *Passes* number of times and each vertex whose deletion would lead to a deviation in the mesh of less than the **Threshold** will be deleted. Elevation Difference is generally slower. The **Edge Cost** method determines the total deviation in the mesh that result from each edge removal (by merging its two vertices) and removes all edges whose removal would result in a deviation of less than the **Threshold**. In addition, the preserve breaklines options for the **Edge Cost** method will multiply the deviation value calculated by the **Breakline Weight** if the angle between the two faces it borders is greater than the **Breakline Angle**, this can be used to help preserve corners. The **Elevation Difference** method is best used in largely flat data (such as a scan of a large open area), while the **Edge Cost** method is best for complex data with lots of corners. Additionally there is a memory tradeoff, the **Elevation Difference** method is generally slower at higher numbers of passes (which gives better results), while the **Edge Cost** method consumes more memory.

## Cleaning a Mesh

To remove spikes from a mesh, *right-click* the target mesh and select **Clean**.

![Clean Mesh dialog](attachment:image.png)

Vertices that meet the parameters of this dialog will have their positions adjusted to meet the shape of the vertices around them, smoothing out the mesh. These parameters are as follows:

**Search Distance** determines the distance for a vertex to search for vertices that exceed the **Delta % Slope**. **Delta % Slope** is the maximum change in slope that is allowed. Vertices that exceed this value are removed. **Passes** determines the number of passes to make over the mesh.

**Tab Location(s):** Project Tab  
**Tree Folder:** Meshes  
**Prerequisite:** An Existing Mesh

### Coordinate Points

Coordinate points are points extracted from the final registered data sets and are a sub-item of the **Processed Data** folder. There can be only one set of coordinate points for a project. There are two ways to manipulate Coordinate Points:

  1. The Right-Click menu  
  2. Coordinate Point Editor

**Edit**  
Launches the Coordinate point Editor
Delete All
Launches the ASCII file import dialog box.

Export
Launches the ASCII file export dialog box.

Transform
Launches the Transform dialog box to allow the user to define a transformation sequence to apply to the Coordinate points.

Field-to-Finish
Launches the Scene creation dialog box to create a scene for viewing the Coordinate points.

View
Launches the Scene creation dialog box to create a scene for viewing the Coordinate points.

Draw
Launches the Scene creation dialog box to create a scene for viewing the Coordinate points.

Notes: Several commands are available in both the Right-Click menu and in the Coordinate Points editor. The difference between a command in the Right-Click menu and in the Coordinate Points editor is the Right-Click menu commands operate on all Coordinate points. The Coordinate Points editor commands operate on only the selected Coordinate Points. If no Coordinate points are selected the users is asked if they wish to perform the operation on all Coordinate points.

The Coordinate Point Editor is activated when the user right-clicks the Coordinate points Folder and selects Edit. In the coordinate point editor there are several base functions that are shared across all point types, with some extended options added for certain points types.

Along the top is a toolbar with several icons. The icons and their corresponding functions are as follows:

- Add Point brings up a dialog that allows you to specify the properties of a new point to add.
- Edit brings up the point edit dialog which allows you to change properties of the currently selected point.
- Copy Points allows you to copy the currently selected points to another point set (such as from the Coordinate points to the target points of a scan).
- Delete deletes the currently selected points.
- Import Points brings up the ASCII file import dialog.
- Export Points brings up the ASCII file export dialog.
- Transform allows you to define a transformation sequence to apply to the points.
View brings up the scene creation dialog for viewing the current point set.

Field-to-Finish allows the user to draw the selected Coordinate Points in CAD using Field-to-Finish. The user is prompted to select the Field-to-Finish (.FLD) file to be used.

Draw to CAD allows the user to draw the selected Coordinate Points in CAD as CAD points. The user is prompted to select the layer to draw the points on.

Coordinate System allows you to choose the coordinate system the positions values are in (Global or any current scan positions)

Settings allow you to configure what properties of the points are visible in the spreadsheet control.

Help brings up help documentation.

Adding Points

Clicking the + button will bring up the add points dialog.

[Image of Add Points Dialog]

Name is a unique name for the point to be used to identify it in Point Clouds.

X, Y, and Z are the x, y, and z coordinates values for the new point to be added.

Description is a description for the point.

Importing Points

Clicking the import button will bring up the import points dialog, which operates very similarly to the import cloud and import scan dialogs.
The settings of this import dialog must be configured to match the data ordering of the file being imported. First, ensure that the Delimiter is set to the correct value, if it is there should be multiple columns in the dialog, if it isn't, all of the data should only be in one column. After the delimiter is properly set, the data values for each column must be set. This can be done by clicking the header of each column (which say <Click to Set> by default) to bring up a menu with all the available values that can be set for that column. After settings these values toggle the importing of lines you wish to leave out by clicking the green buttons in the Import column to turn them red. At the top of the dialog is the presets panel, which will allow you to save the current settings if you wish to use them again later. After configuring the dialog to your liking, click the green check to import to continue to the next step. The next dialog displayed will allow you to configure the naming conventions for the points to be imported.

Selecting Rename all items will rename all imported points to the settings specified in the options. The Duplicate Entries panel will specify the action to take when a point being imported has a name that already exists in the set of points being imported to. If the Rename all items toggle is not selected the names listed in the file being imported will be used. If there are no names in the file being imported and Rename all items is not selected, the control points will be named using the settings in Project Settings naming conventions.

Exporting Points
Clicking the export button will bring up the export points dialog, which will allow you to export the data to several different file formats.

Simply click the check boxes next to the data elements that you wish to export. To change the order of the data elements in the file, select the data element you wish to move and click the up or down arrow to move it.

The File panel determines which file format to export to and also allows you to specify an extension other than the default for a given file format.

The Text allows you to specify the Delimiter to be used as the divider between data elements in the file and whether to use the Write header to specify whether to write a header line to the file detailing the data ordering of the file.

Transform Points

The Transformation allows specifying a sequence of transformations to apply to the currently selected points.
Initially the transformation list is empty. Press the green plus button to add a new transformation, which will bring up a new dialog.

There are three types of transformations, as well as an advanced transformation where the user can specify the transformation matrix to apply.

1. **Translation** transformations move the points linearly along the offset values specified.
2. **Rotation** transformations rotate the points around the axis specified the angle specified.
3. **Scaling** transformations scales the selected points (using the global origin as the origin for the scaling) in each dimension by the amount specified.

After the transformation's settings have been configured, pressing the green check mark will add it to the current list of transformations. In the Transformation sequence dialog the following functions apply:

- ![Edit](edit.png) Will allow you to edit the currently selected transformation.
- ![Delete](delete.png) Will delete the currently selected transformation.
- ![Reorder](reorder.png) Will change the order of applications of the transformations. Transformations are applied in top-to-bottom order.

**Settings**

The Settings button will bring up the Coordinate Point Editor settings dialog, which will allow the user to configure which data elements of the current point set are visible, as well as the order that they are displayed in.
Display of a property can be changed by toggling the check box next to that property, changing the order can be done by first selecting the property to move and then pressing the green up and down arrows to move the selected property up or down. Saving the current settings can be done clicking the plus button in the Presets panel.

Tab Location(s): Project Tab
Panel and Button: Current Project and Coordinate Points
Prerequisite: None

Common Utilities

Layer Properties Manager

The Layer Properties Manager can be accessed form the Project Tab by right clicking on Layers and selecting Edit or from the Scene Viewer by clicking the Layer Properties Manager icon.
Adds a new layer to the list. Default layer name is Layer# were # starts at one and increases by one as layers are added.

Places a cursor in the Name field of the highlighted layer to allow editing of the name. If no layer is highlighted The cursor will be placed in the first layer in the list. You can also edit layer names by double-clicking a layer name.

Deletes the layer currently selected. You may not delete a layer that has polylines drawn on it.

**Status:** Identifies the layer that is Current.

**Name:** Shows the layer name.

**Freeze:** Toggles the freeze mode on and off. When toggle on polylines on this layer will not be displayed.

**Color:** Shows the color assigned to each layer. Click the color box to select a different color. Polylines drawn on a layer will be drawn in the color assigned to the layer.

**Tab Location(s):** -Project Tab or Scene Viewer-

**Prerequisite:** -None-

---

**Polyline Editor**

The Polyline Editor is activated anytime the user right-clicks a polyline in the project tree and selects **Edit**. The Polyline editor can also be launched from The Action Tab when the current mode is Polyline Creation. Simply highlight a polyline to make it active and select the **Edit** button.

Along the top is a toolbar with several icons. The icons and their corresponding functions are as follows:

- **Move Vertices up** will move the selected vertex or vertices up one position each time it is clicked.

- **Move Vertices Down** will move the selected vertex or vertices down one position each time it is clicked.

- **Add Vertex** brings up a dialog that allows you to specify the properties of a new vertex to add.

- **Edit Vertex** brings up the edit vertex dialog which allows you to change properties of the currently selected vertex.

- **Delete Vertices** deletes the currently selected vertex or vertices.

- **Import Vertices** brings up the Carlson file selection dialog.

- **Export Vertices** brings up the ASCII file export dialog.
Transform allows you to define a transformation sequence to apply to the vertices. Coordinate System allows you to choose the coordinate system the positions values are in (Global or any current scan positions). Settings allow you to configure what properties of the vertices are visible in the spreadsheet control. Help brings up help documentation.

**Adding Vertices**

Clicking the Add Vertices button will bring up the add vertices dialog.

![New Vertex Dialog](image)

X, Y, and Z are the x, y, and z coordinates values for the new vertex to be added. Type can be either Basic or Coordinate Point Reference. The Reference Panel is activated when the vertex type is set to Coordinate Point Reference.

**Importing Vertices**

Clicking the import button will bring up the Carlson file selection dialog. Three file types are support for polyline import; TXT, PLN and CL.

**Exporting Vertices**

Clicking the export button will bring up the export vertex dialog, which will allow you to export the data to several different file formats.
Simply click the check boxes next to the data elements that you wish to export. To change the order of the data elements in the file, select the data element you wish to move and click the up or down arrow to move it. The **File** panel determines which file format to export to and also allows you to specify an extension other than the default for a given file format. The **Text** panel features options for exporting to the selected text file type. **Delimiter** determines the divider between data elements in the file. **Write header** specifies whether to write a header line to the file detailing the data ordering of the file.

**Settings**

The Settings button will bring up the Polyline Editor Settings dialog, which will allow the user to configure which data elements of the current vertex set are visible, as well as the order that they are displayed in.
Display of a property can be changed by toggling the check box next to that property, changing the order can be done by first selecting the property to move and then pressing the green up and down arrows to move the selected property up or down. Saving the current settings can be done clicking the plus button in the Presets panel.

Tab Location(s): Project Tab and Action Tab
Access Command: Right-Click Points and select Edit (Project Tab) Click Edit button (Action Tab - Polyline Creation mode)
Prerequisite: Scene with a polyline

Control Point Editor

Control points are the global positions of the target points, and are a sub-item of the Instrument Data folder. There can be only one set of control points for a project. There are two ways to manipulate Control Points:

1. The Right-Click menu
2. Control Point Editor

Edit
Delete All
Import
Export
Transform
View
Draw

Launches the Control Point Editor
Deletes all Control Points. The user is prompted via a dialog box to confirm the deletion.
Launches the ASCII file import dialog box.
Launches the ASCII file export dialog box.
Launches the Transform dialog box to allow the user to define a transformation sequence to apply to the control points.
Launches the Scene creation dialog box to create a scene for viewing the control points.
Draws the Control Points in CAD. The user is prompted via a dialog box for the layer to draw the Control Points on.

Notes: Several commands are available in both the Right-Click menu and in the Control Points editor. The difference between a command in the Right-Click menu and in the Control Points editor is the Right-Click menu commands operate on all control points. The Control Points editor commands operate on only the selected Control Points. If
no control points are selected the users is asked if they wish to perform the operation on all control points.

The Control Point Editor is activated when the user right-clicks Control Points &rArr; Edit.

Along the top is a toolbar with several icons. The icons and their corresponding functions are as follows:

- **Activate Control Point** toggles the selected control point(s) to be active in the current project.
- **Deactivate Control Point** toggles the selected control point(s) to be inactive in the current project.
- **New Control Point** brings up a dialog that allows you to specify the properties of a new control point to add.
- **Edit Control Points** brings up the point edit dialog which allows you to change properties of the currently selected Control Point.
- **Copy Control Points** allows you to copy the currently selected Control points to another point set (such as from the control points to the target points of a scan).
- **Delete Control Points** deletes the currently selected control points.
- **Import Control Points** brings up the ASCII file import dialog.
- **Export Control Points** brings up the ASCII file export dialog.
- **Transform Control Points** allows you to define a transformation sequence to apply to the control points.
- **View Control Points** brings up the scene creation dialog to create a scene for viewing the current control point set.
- **Coordinate System** allows you to choose the coordinate system the positions values are in (Global or any of the current scan positions)
- **Settings** allow you to configure what properties of the control points are visible in the spreadsheet control.
- **Help** brings up help documentation.

**New Control Point**
Name will specify a unique name to be used for the Control Point in the Project. X, Y and Z may be in feet (ft) or Meters (m) as shown. These are the coordinates of the Control Point. Description allows you to optionally add information that describes the new Control Point. Target Points allows the user to specify Target Points from any Scan to be referenced to the new Control Point.

- Adds a new reference Target Point.
- Allows the user to edit the selected reference Target Point
- Deletes the selected reference Target Point

Import Control points
The settings of the import dialog must be configured to match the data ordering of the file being imported. First, ensure that the Delimiter is set to the correct value, if it is there should be multiple columns in the dialog, if it isn't, all of the data should only be in one column. After the delimiter is properly set, the data values for each column must be set. This can be done by clicking the header of each column (which say Click to Set by default) to bring up a menu with all the available values that can be set for that column. After setting these values, toggle the importing of lines you wish to leave out by clicking the green buttons in the Import column to turn them red. At the top of the dialog is the presets panel, which will allow you to save the current settings if you wish to use them again later. After configuring the dialog to match your data, click the green check to import and continue to the next step. The next dialog displayed will allow you to configure the naming conventions for the points to be imported.

Selecting Rename all items will rename all imported points to the settings specified in the options. The Duplicate Entries panel will specify the action to take when a point being imported has a name that already exists in the set of points being imported to. If the Rename all items toggle is not selected the names listed in the file being imported will be used. If there are no names in the file being imported and Rename all items is not selected, the control points will be named using the settings in Project Settings naming conventions.

Exporting Points
Clicking the export button will bring up the export points dialog, which will allow you to export the data to several different file formats.

Simply click the check boxes next to the data elements that you wish to export. To change the order of the data elements in the file, select the data element you wish to move and click the up or down arrow to move it.

The File panel determines which file format to export to and also allows you to specify an extension other than the default for a given file format.

The Text allows you to specify the Delimiter to be used as the divider between data elements in the file and whether to use the Write header to specify whether to write a header line to the file detailing the data ordering of the file.

**Transform Points**

The Transform Coordinate Points dialog allows specifying a sequence of transformations to apply to the currently selected points.
Initially the transformation list is empty. Press the green plus button to add a new transformation, which will bring up a new dialog.

There are three types of transformations, as well as an advanced transformation where the user can specify the transformation matrix to apply.

1. **Translation** transformations move the points linearly along the offset values specified.
2. **Rotation** transformations rotate the points around the axis specified the angle specified.
3. **Scaling** transformations scales the selected points (using the global origin as the origin for the scaling) in each dimension by the amount specified.

After the transformation's settings have been configured, pressing the green check mark will add it to the current list of transformations. In the Transformation sequence dialog the following functions apply:

- Will allow you to edit the currently selected transformation.
- Will delete the currently selected transformation.
- Will change the order of applications of the transformations. Transformations are applied in top-to-bottom order.

**Settings**

The Settings button will bring up the Point Editor settings dialog, which will allow the user to configure which data elements of the current point set are visible, as well as the order that they are displayed in.
Display of a property can be changed by toggling the check box next to that property, changing the order can be done by first selecting the property to move and then pressing the green up or down arrows to move the selected property up or down. Saving the current settings can be done clicking the plus button in the Presets panel.

**Tab Location(s):** Project Tab  
**Panel and Button:** Current Project and Control Points  
**Prerequisite:** None

**Point Editor**  
The Point Editor is activated anytime the user right-clicks a set of points and selects *Edit*. In the point editor there are several base functions that are shared across all point types, with some extended options added for certain points types.
Along the top is a toolbar with several icons. The icons and their corresponding functions are as follows:

- **Add Point** brings up a dialog that allows you to specify the properties of a new point to add.
- **Edit** brings up the point edit dialog which allows you to change properties of the currently selected point.
- **Copy Points** allows you to copy the currently selected points to another point set (such as from the control points to the target points of a scan).
- **Delete** deletes the currently selected points.
- **Import Points** brings up the ASCII file import dialog.
- **Export Points** brings up the ASCII file export dialog.
- **Transform** allows you to define a transformation sequence to apply to the points.
- **View** brings up the scene creation dialog for viewing the current point set.
- **Field to Finish** Draws the selected points in CAD using the current FLD file and field to finish settings.
- **Draw to CAD** brings up the Point Draw Settings dialog specify a layer to draw the selected points on in CAD and specify if the points should be added to the current CRD file.
- **Coordinate System** allows you to choose the coordinate system the positions values are in (Global or any current scan positions).
- **Settings** allow you to configure what properties of the points are visible in the spreadsheet control.
- **Help** brings up help documentation.

The Target Points editor has an additional toolbar button:
Register begins the scan registration process for the current set of target points.

**Adding Points**

Clicking the **Add Point** button will bring up the add points dialog.

![New Coordinate Point dialog](image)

- **Name** is a unique name for the point to be use to identify it in PointCloud.
- **X**, **Y**, and **Z** are the x, y, and z coordinates values for the new point to be added.
- **Description** is a description for the point.

**Importing Points**

Clicking the import button will bring up the Carlson file selection dialog. Three file formats are supported for import; TXT, CSV and CRD. Once a file is selected and opened the Import dialog is displayed.

![Import Control Points dialog](image)

Selecting **Rename all items** will rename all imported points to the settings specified in the options. The **Duplicate Entries** panel will specify the action to take when a point being imported has a name that already exists in the set of points being imported to.

**Exporting Points**

Clicking the export button will bring up the export points dialog, which will allow you to export the data to several different file formats.
Simply click the check boxes next to the data elements that you wish to export. To change the order of the data elements in the file, select the data element you wish to move and click the up or down arrow to move it. The **File** panel determines which file format to export to and also allows you to specify an extension other than the default for a given file format. The **Text** panel features options for exporting to the two different text file types. **Delimiter** determines the divider between data elements in the file. **Write header** specifies whether to write a header line to the file detailing the data ordering of the file.

**Transform Points**

The Transform allows specifying a sequence of transformations to apply to the currently selected points.

Initially the transformation list is empty. Press the green plus button to add a new transformation, which will bring up a new dialog.
There are three types of transformations, as well as an advanced transformation where the user can specify the transformation matrix to apply. **Translation** transformations move the points linearly along the offset values specified. **Rotation** transformations rotate the points around the axis specified the angle specified. **Scaling** transformations scales the selected points (using the global origin as the origin for the scaling) in each dimension by the amount specified. After the transformation’s settings have been configured, pressing the green check will add it to the current list of transformations.

In the Transformation sequence dialog, pressing the green i button will allow you to edit the currently selected transformation. The red x button will delete the currently selected transformation and the green arrows will change the order of applications of the transformations. Transformations are applied in top-to-bottom order.

**Settings**

The Settings button will bring up the Point Editor Settings dialog, which will allow the user to configure which data elements of the current point set are visible, as well as the order that they are displayed in.
Display of a property can be changed by toggling the check box next to that property, changing the order can be done by first selecting the property to move and then pressing the green up and down arrows to move the selected property up or down. Saving the current settings can be done clicking the plus button in the Presets panel.

**Registering Target Points**

The scan registration process begins with pressing the Register button in the toolbar of the Target Points Editor.

Carlson PointCloud supports four different methods of scan registration. **Use existing references** will make PointCloud only use the references that already exist to perform the registration process (these references can be set manually in the Points Editor, or could have been set in a previous registration process). **Match point names** will match target points up with control points with the same name. **Match Point Description** will match target points with control points with the same description. **Minimize position error** will attempt to automatically transform the current target points so that they match up with the control points, creating control point-target point pairs. If such a transformation that meets these conditions exists, the target points will have their reference control points set to the control point they were paired with. After pressing ok, a dialog will display informing the user if the registration was successful. After all scans have been registered, the best thing to do is verify that they’re all registered properly by viewing them in the same scene and verifying that surfaces look similar where the scans overlap.
Tab Location(s): Project Tab  
Access Command: Right-Click Points and select Edit  
Prerequisite: Control Points or Target Points or Coordinate Points  

**Item Properties**

To see general statistical information about scans, clouds, meshes, and scenes you can right-click the object and select the **Properties** option to open the properties dialog.

The Properties dialog can have different tabs depending on the data object selected. The Cloud page, pictured above, has a cloud and notes tab. The **Scan** properties adds a scan tab and preview tab to cloud and notes. The **Mesh** properties adds a mesh tab to the cloud and notes tab.

The **Preview** tab found in scan properties will show a small preview of the scan data in 2D.

The **Notes** tab features a textbox where you can add notes to the object for future reference.

Each of the **Cloud**, **Mesh**, and **Scan** pages all feature information about the size of their respective datasets, as well as statistical information about the data objects.

Tab Location(s): Project Tab  
Prerequisite: A Scan, Mesh or Cloud

**Increasing Available Memory**

Prior to running Carlson PointCloud, you may want to enable the Windows user-mode 3 gigabyte virtual memory switch. This switch will enable Carlson PointCloud to address 3 gigabytes of memory instead of the windows default of 2 allowing it to handle larger data sets. Some video drivers may not load when the 3 GB switch is used. Typically, if you're going to work on a dataset of more than 5 million data points and create a mesh from it, this switch should be enabled. To enable this option, navigate to the root directory of the hard drive that Windows XP is installed on (typically the C: drive), and locate the boot.ini file. This file may be hidden, so visibility of hidden files may be needed to be enabled (done by going to the **Tools** menu in windows explorer and selecting **Folder Options...**, going to the View tab and selecting **Show hidden files and folders**).

In the boot.ini file, there should be an [operating systems] line, after which there will be lines that detail the operating system to load on system boot. Typically, there will only be one line following the [operating system] line, which will be the boot options for Windows. The Windows boot line should look something like the following:

multi(0)disk(0)rdisk(0)partition(2)\WINDOWS=\"Microsoft Windows XP Professional\" /noexecute=option /fastdetect
Some of the numbers may be different and the name may be different depending on the version of Windows you're using (i.e. "Windows XP Home"), but the format of the line should be the same. Add /3G to the line to enable the 3 gigabyte switch, in the case of the above line, it would be changed to the following:

multi(0)disk(0)rdisk(0)partition(2)\WINDOWS="Microsoft Windows XP Professional" /noexecute=optin /fastdetect /3G

The system will need to be rebooted to apply the changes, but afterwards Carlson PointCloud will be able to handle significantly larger datasets.

Point Clouds Step-by-Step Tutorial

Tutorial Setup

The following is an introductory tutorial for Carlson Point Clouds. If you wish to follow along with the tutorial and use the same Scan files, you can download them from the Carlson website at http://update.carlsonsw.com/tutorials/pointcloud/data.zip

These files aren't required, however, and you can follow along with any set of scans that have proper target points and control points.

Project Setup

Work done in Carlson's Point Cloud module is done on a per-project basis. To create a new project, you must first have a CAD drawing open in AutoCAD or IntelliCAD. To load the Point Cloud menu structure, click on the Lightning Bolt icon, or load it through the menus by going to Settings ⇒ Carlson Menus ⇒ Point Clouds.

This will display the menu structure for Point Clouds. Now select Point Clouds ⇒ Project Manager. Then select New for a New project. Select the file path where you want it stored, enter in a filename and then click on Save.

Your initial project should look like the following image. In the tree structure you will see your Project with various defaults.
First, let's change some general project settings. This will allow the units, the look and the feel to be correct for your environment. This can be done either by double-clicking on the **Settings** item in the tree, or by a right-clicking the **Settings** item and selecting **View** from the menu. In the **Units and Ranges** section, you may change the project's units between Meters or Feet, which is the default. For this exercise, select **Meters**.

The **Naming Conventions** section allows you to change the settings for the naming of various fields. Look over the defaults, and if you wish to change something to your liking, please do so.

Finally, take a look at the **Viewer** section and make any changes to the defaults if you desire.

Once this is done, click on the green check mark button to accept the Project settings. Typically, to accept the results of or continue with a function you should click the green check mark button; if you want to cancel a process click the red X.

The tutorial scan set that is supplied for this exercise will consist of three different scanner setups, each having obtained a scan in their own scanner coordinate system. Included with these scans are targets scans for each scan and the control coordinates for the site. This will allow us to complete a full registration of the three point clouds, and merge them into one entity for further manipulation.

Let's begin by adding two more scan position trees.

Right click on **Instrument Data** ⇒ **Add** ⇒ **New Position**. Do this one more time, to have a final count of three Scan Positions, as per the diagram below.

We will now proceed with adding the information to the scans.

**Project Import**

Right click on **Scan Position 01** ⇒ **Import** ⇒ **Scan**.

It will now displayed another dialog box asking you for the text file that has the necessary scan data in it in symbol delimited format, consisting of X, Y, Z, Intensity and R, G, B values.
Navigate to where the scans you wish to use and select the scan file. If you're using those from the Carlson website, select the following file: **Color_ScanPos01 - Pa01.txt**

You will now see an Import Scan dialog box.

![Import Scan dialog box](image)

Click on the green button under the heading Import, and it will change to red. This means it will not import that line of text. Typically, the first line in a text scan file will be a list of data types and should not be imported.

Now, we need to assign each of the fields with their respective information. This is done by left-clicking on the column headers and selecting the data type for that column. Click the column header above X[m], which should be in the first row of data, and select **X[m]** from the drop down menu. Continue this process for each column of data until all of the columns have the proper headers.

To store this header arrangement for future use, click on the green plus sign button and it will assign a preset for you. This column header preset can now be used every time you import scan files with the same data ordering.

Now you will need to enter in the scan resolution values as well as information about how the scan data is oriented. If you're using the data set from the Carlson website, please refer to the supplied **Dimensions.txt** file for this information on the three scans.

After clicking the green checkmark you should see the scan import progress dialog.
Continue to import the other two scans to their respective scan positions, this time you can utilize the preset made from the first one by selecting it from the presets drop down box. Once the scans have been imported, each of your scan position trees under the project should have the following structure:

Now let's import the scanned targets for each of the scans, and the control for the registration process. This procedure is similar to importing the scan. The only difference is that you now right-click on Target Points [0] for each scan and select Import.

You will have various options, if required, for importing the points. For the tutorial dataset, make sure the Rename all items checkbox remains unchecked and the Ignore Duplicates radio button is selected. Once these are done
click on the green check mark to accept your choice. You will now see that the zero value has increased to 7.

Continue to import the Target points until each of the scan positions have their target scans imported, and then do the same with the Control Points, which is at the top of the tree.

Once all of this has been done, click on Save to perform a save of all the data that has been imported.

### Project Registration

This is done by going into the scanned target data and applying a registration to the control.

Double left click on the Target Points in the scan tree, or right-click ➔ Edit and it will display a window to the above diagram. The information displayed in the spreadsheet can be modified by clicking the Settings icon and modifying them to your liking.

Once this is done, click on the Register Scan Position icon and a popup will appear as shown below.

Set the method to **Minimize point position error**. You may need to up the value of the Maximum Error to allow for a larger search radius until all of the points have been matched.

Look at the residuals and make sure that are to your satisfaction. Each scan will differ. Once this is done, it will inform you that the registration has been successful. Continue registering target points in other scans until all scans are registered.

Now each of the Point Clouds has a different co-ordinate systems assigned to them.
Creating a View of All Scans

Now we will create a view and add all the scans to the same view for further manipulation.

Select Scan Position 01 - Scan 01 by either a double left-click or right click > View and it will open a dialog box as seen below.

Select the **Create new** option, and leave the default name for the Scene. Remember the scene name for later, as you're going to add the other scans to it. Set the display mode to 3D and in the color panel choose **Color** for the category and **Direct** for the type. After clicking the green check mark a new window should pop up after the scan has loaded that shows a scene similar to the one below.

![Scene creation dialog box](image)

After creating the initial scene, go back to the project manager and right click Scan Position 02 - Scan 01 and select **View**. This time we will choose **Append to existing** and select the Scene created from the last scan. Make sure the coloring options are the same as the other and that the Mode is set to 3D and click the green check mark.
Your scene window should update to reflect your changes. Repeat this process again for Scan Position 03 - Scan 01 and add it to the same scene. Your final scene should look something like the one below.

Isolating the Area of Interest

The scanner has picked up some points outside our area of interest. To eliminate them from the data set, click on the Action tab and use the Polyline Selection tool to select the desired data points. Make sure the Micro selection mode is on. Macro mode means that if any part of a dataset is selected, that entire dataset is selected, which is not the selection behavior we want here.
Make a new Cloud from the selected points by clicking **Cloud** in the create panel of the Action tab. This will launch the Create Cloud dialog. Click the green check mark to create a new point cloud containing just the selected points. You can locate the new cloud under Project ⇒ Processed Data ⇒ Clouds.

---

**Resampling Point Cloud Data**

The new point cloud contains data from three different scan positions. Inevitably, some of the data points are duplicated in the areas where scans overlap. You can now resample your cloud to eliminate unwanted data points.

To do so, right click on the cloud in the Project tab, and select the **Resample** option. This will bring up the Resample Cloud dialog.
The Oc-Tree resampling method typically provides the best results. Leave the Oc-Tree dimensions unchanged, and specify Oc-Tree Resolution and Node settings as shown. Click the green check mark to create your new, resampled point cloud. This process may take a few minutes. After it is complete, you will have a new resampled cloud under Project ⇒ Processed Data ⇒ Clouds.

Creating a Mesh Surface

Now that you have isolated and resampled your area of interest, you can make a triangulated mesh surface from your data points.

The simplest way to do so is to right click your resampled point cloud and select Create Mesh. This will launch the Create Mesh dialog.

Change the maximum edge length setting to 50 meters and maximum incident angle to 90°; this will prevent valid triangular faces from being eliminated during the triangulation process. Click the green check mark to create your
mesh. This process may take a few minutes. After it is complete, you will have a new mesh under Project ⇒ Processed Data ⇒ Meshes.

You can export a mesh to a Carlson 2007 TIN file by right-clicking on it, and selecting Export.

**Automatic Breakline Extraction**

The next task is to automatically draw in breaklines for top and bottom of bank of the data set. To do so, right click your mesh and select View. This will launch the View Mesh dialog.

Select Position for Color Category, Normal for Color Type and click the green check mark to view your mesh.

Each vertex in your mesh is colored according to the direction of the normal vector. Think of it as the "up" direction. The axis icon gives you a good idea of how the colors are assigned. Its x-axis is colored red, y-axis is colored green and z-axis is colored blue.

Vertices that "face" the x-axis have a higher saturation of red, vertices that "face" the y-axis have a higher saturation of green and vertices that "face" the z-axis have a higher saturation of blue.

Access the Action tab and select all the vertices in your data set. The simplest way to do so is to click the All button with the Add radio button selected.
Initiate the breakline extraction process by clicking **Extract Breaklines** in the **Action** tab. This will display the breakline extraction options panel.

The next task is to set up your **Direction - Color zones**. To create a zone, ctrl-click on a data point inside the viewer. To delete one or more zones, highlight them in the spreadsheet, and click the Delete button.

Think of zones as groups of points which all face a similar direction. In this particular example, there are two such groups: points in the flat area on the bottom of the trench (low slope) and points on the walls of the trench (high slope). Ctrl-click on one sample point in each zone.

Click the **Show** button to preview your zones. At this stage, for each point in your selection set, the program figures out which of the sample points it is most similar to, in terms of orientation or color, and shades it accordingly.

The breaklines will be extracted at the boundaries between adjacent zones.
Active Directions - Color toggles help you fine tune zone processing. For example, two data points may have similar facing along the x-axis but vastly different facing along the z-axis. This would be indicated by similar red values but different blue values.

You can examine the value of any data point under your cursor in the Data tab. This helps with setting up your zones.

Also, you can use Zone smoothing settings to get rid of some of the unwanted noise inside the zones and along the zone boundaries.

To extract the breaklines, you need to specify the maximum distance between adjacent breakline, as well as the smoothing and simplification settings.

Once you are happy with the zones and the preview, click Extract to extract the breaklines and view your results.

Your breaklines will appear under Project tab ⇒ Processed Data ⇒ Polylines. You can delete unwanted polylines by right-clicking on them, and selecting Remove.
Virtual Survey

In this particular example, the automatic breakline extraction is not sensitive enough to detect outlines of roads at the bottom of the trench. These road features can be surveyed in manually.

To do so, close the current viewer, then right click your mesh and select View. This will launch the View Mesh dialog.

Select Color for Color Category, Direct for Color Type and click the green check mark to view your mesh.
Access the **Action** tab and click **Point** in the Create panel. This will display virtual survey options.

First, select **Coordinate Points** from the choices in the Active List box. This means that each point you create is a common coordinate point (not a control or target point used for registering scans).

Next, specify a suitable point name (sometimes called point number) and a description for the next point you are going to create. You can use the **Pick** button to access the contents of your current field-to-finish codebook file.

Ctrl-click in the viewer to create new coordinate points.

Field-to-finish linework will be generated automatically according to your field-to-finish codebook. You may also use the Linework portion of the dialog to append special codes to your coordinate points.

You can view and edit coordinate points that you have already created by right clicking on Coordinate Points and selecting **Edit** in the Project tab.
You can export your coordinate points to a CRD file by right clicking on Coordinate Points and selecting Export in the project tab. (CRD is one of several available formats.)

This completes this Point CloudStep-by-Step tutorial.
Introduction and Overview

Traditional landscape design is often based on the subjective judgment of landscape appearance or desired land use with little consideration for proper hydrologic function for balanced conveyance of water and sediment from the land surface. Alternately, traditional design methods might use engineering principles to create structural controls for water and sediment conveyance (Bugosh, 2000). Over the last several decades, fluvial geomorphic research has identified distinct relationships among several important factors including climate, discharge, slope, and earth materials that define stable stream channels (Bloom, 1978) (Dunne and Leopold, 1978) (Williams, 1986). The Carlson Natural Regrade module applies fluvial geomorphic principles to upland landforms through computer software (GeoFluv™). GeoFluv™creates a landscape design that mimics the functions of the natural landscape that would evolve over time under the physical and climatic conditions present at the site to convey the water and sediment from the land surface in a stable hydrologic equilibrium.

The following sections summarize why GeoFluv™ benefits reclamation landform design and description of how computerizing the approach provides a value multiplier by allowing detailed designs to be made and evaluated quickly. The "Problems Addressed by Natural Regrade" section discusses limitations of conventional approaches to disturbed-land reclamation design. "The Fluvial Geomorphic Solution" section discusses how and why Natural Regrade's GeoFluv™ approach solves the problems inherent in the conventional approaches. The "Description of Software" section explains fundamental concepts and terminology used in GeoFluv™ approach, and how and where these are used in the Natural Regrade module.

The remaining sections are as follows. The "Links with other Software" section describes other software that the user can use along with Natural Regrade to achieve even greater efficiency when constructing the GeoFluv™ design (or any other construction project). The "Software Compatibility" section describes the CAD software that Natural Regrade is designed to work with.

Problems Addressed by Natural Regrade with GeoFluv

Conventional land-shaping practices are often based on conveying or capturing runoff from an extreme event. These conventional practices include grading slopes to a uniform gradient, building gradient terraces across slope faces, and constructing rip-rapped down drains to convey runoff as shown in Figure 1.

Use and Cost Limitations of Conventional Approach

Conventional designs often do not address the hydrologic balance during less extreme flow conditions. This results in problems with reclamation success for vegetation, livestock, and wildlife post-disturbance land uses, high maintenance costs, and reclamation bond complications.
The unnatural configuration of these designs does not provide the terrain diversity that creates spatial variation in water harvesting and slope aspect. The result is that vegetation tends toward a monoculture and animal habitat is minimized. The native land in the foreground of Figure 1 has forbes and shrubs growing near minor gullies, whereas the uniformly-graded slopes above them do not favor these plants, despite having been seeded with them.

Conventional land-shaping practices have high construction, maintenance, and liability costs. Terraces can be difficult and expensive to grade on steep side slopes. The rip-rap material may have to be procured off site and transported to the site. After construction, regular maintenance is often required as the terraces and ditches sized for extreme flows become clogged with sediment at lower flows, or are penetrated by burrowing animals. Clogged or burrowed terraces can result in catastrophic diversions of runoff from the terraces straight down the slope, often requiring major repairs.

**Bonding Limitations of Conventional Approach**

The conventional approach to reclamation landform design affects reclamation bonding liability and costs. The damage to the slope from a blowout and related repair work can result in a reclamation bond clock being restarted, which prolongs the operator's period of liability. The expense of creating land form designs has often limited an operator's ability to propose incremental reclamation bonding for various stages of a project's disturbance. For example, an operator may determine that their greatest disturbance will occur at year four of a five-year permit and they may post a bond for that maximum disturbance, even though their liability will be lower for the first four years. This creates an unnecessary financial burden for the operator.

**The Fluvial Geomorphic Solution**

This fluvial geomorphic landscape computer-design software (GeoFluv™) uses an algorithm based on fluvial geomorphic principles. The essence of this approach is to identify the type of drainage network, i.e., stream channels and valleys, which would tend to form over a long time given the site's earth materials, relief, and climate to achieve a stable landform, and to design and build that landform. The resulting slopes and stream channels are stable because they are in balance with these conditions (Rosgen, 1996). They are a reclamation alternative to uniform slopes with terraces and down-drains. Rather than fight the natural forces that shape the land, the algorithm helps the user create a landscape that harmonizes with these forces.
The channel and swales in the foreground, and the steep slope ridges, valleys, and channels in the center of Figure 2, are examples of portions of a 115-acre coal mine reclamation project completed using this innovation fluvial geomorphic approach.

Figure 2. Steep slope reclamation using the fluvial geomorphic approach shown during the second growing season

Natural Stability
Over the last thirty-some years hydrologists have observed and measured stable natural streams and determined mathematical relationships that describe these stable stream types. Essential among these determinations is that channel morphology is directly related to a relatively small, but frequently recurring annual flood event. The natural channel is shaped to keep its sediment load and stream flow in balance during these low-flow events, as well as during extreme events. The GeoFluv™ fluvial geomorphic approach to land reclamation relates the upland landforms to the stream channel form. Both can be formed similarly by flowing water. Reclamation landscapes created using fluvial geomorphic principles provide stability against erosion with runoff waters capable of meeting water quality criteria, and support a diverse vegetative community. These landscapes offer the benefits of lower initial cost, no long-term maintenance costs, and they promote bond release (Bugosh, 2002, 2003).

Promotes Bond Release
The GeoFluv™ fluvial geomorphic approach provides a high degree of confidence that reclamation projects will demonstrate long-term stability against erosion similar to adjacent undisturbed lands because the reclamation channels are designed to maintain the hydrologic balance, as the natural channel does. This means that the reclaimed land does not have to be regularly disturbed to repair erosion problems. Additionally, the varied landform provides niches for different plants, wildlife, and livestock. These benefits demonstrate to regulatory authorities that the site will remain stable and productive; that demonstrated stability can promote bond release.

Benefits of Computerizing the Fluvial Geomorphic Approach
Previous application of alternative land-shaping practices may have been limited for several reasons, including the limited extent of training in fluvial geomorphic principles of the designers, the complexity of the design calculations to create a thoroughly integrated landform, and the difficulty of guiding the heavy equipment operators to build more sophisticated designs. The Natural Regrade module addresses all these potential limitations. GeoFluv™ creates a
draft landform based on empirically determined fluvial geomorphic mathematical relationships. The draft landform is an idealized solution that uses the input parameters to create a stable landform. The designer can then modify this idealized draft landform to conform to special site conditions, such as an archaeological site, landmark, or other feature, or to create a more natural appearance.

User Friendly
Existing computer software for earth-moving designs does not incorporate this innovative approach, is often not "user friendly", and does not have the broad applications for landscape designs that are stable against erosion offered by Natural Regrade. GeoFluv™ makes "user friendly" computer design software available to a large body of users that do not have advanced training in fluvial geomorphology, as well as to those who do have this background. Natural Regrade has been designed to be as "user friendly" as possible; the program commands are organized following a left-to-right and top-to-bottom format that follows the project design work sequence, with minimal input needed and with guidance provided in the "Help" resource and documentation.

Minimizes Training
The Natural Regrade module minimizes the training necessary to immediately use the fluvial geomorphic approach for reclamation at disturbed sites, or when evaluating proposed reclamation designs. Users can compress design time and build reclamation landscapes from disturbed earth to seeded reclamation. GeoFluv™'s developer has successfully introduced this reclamation approach to the largest mining company in the world at truck-and-shovel and dragline operations. The Natural Regrade module is designed to quickly make the GeoFluv™ design approach available to the widest range of users including professional hydrologists, environmental scientists, and engineers responsible for reclamation design at disturbed sites, and for regulatory personnel responsible for evaluating reclamation designs.

Simplifies numerous complex calculations
An important advantage of the Natural Regrade module's GeoFluv™ computerized approach is the ease by which the user can create landscapes that are functional, stable against erosion, low-maintenance, aesthetically pleasing, and cost-effective. The GeoFluv™ computer design software offers several options for developing input parameters from climatic and hydrologic data, and several options for creating landscape features, e.g., ephemeral, intermittent and perennial stream channels, complex slopes, ridges and valleys, and calculating material balances and centroids, and optimum material movement routes, for the resulting design. The user can design channels with appropriate characteristics, including channel patterns, sinuosity, longitudinal profiles, cross sectional areas, width to depth ratios, etc. and their contiguous uplands as functional components of a stable topography for tens of acres of land in minutes. GeoFluv™ allows the user to view topographic maps and three-dimensional images of the resulting landscape design. The GeoFluv™ approach replaces lengthy and tedious manual calculations and allows rapid evaluation of many landscape design alternatives. This allows the user to select the optimum landscape design for his needs.

Promotes Bonding Alternatives
The ability to quickly create and evaluate alternative reclamation designs provides great utility for both industry and regulatory personnel working on reclamation bonds. Because designing a reclamation surface has been such a lengthy and expensive process, often only a 'worst case scenario' design has been created for setting a reclamation bond. For example, this 'worst case scenario' may have been based on the disturbance in year four of a five-year mine permit. The ability to quickly create design surfaces and conduct mass balance comparisons makes it practical for the Natural Regrade module user to propose bonds for several stages of mine development, i.e., incremental bonding, that can reduce bond costs and promote release of more acres from bond.

Interface with GPS and Machine-control Software
This software also is ideal for integrating with Global Positioning System and laser machine control to simplify and speed construction and reduce costs. Construction of the complex landforms that are characteristic of stable natural landscapes, and which GeoFluv™ helps the user design, is facilitated by GPS and machine guidance technologies. The need to survey and stake the designs in the field is eliminated using these technologies, as is the need for the construction team to constantly provide guidance to the equipment operators.
Description of Software

GeoFluv™ requires only minimal input parameters to produce a draft surface and the material balance associated with creating that surface. The software outputs a draft landform that provides a solution for a stable landform that satisfies the input parameters. The software also displays the cut/fill balance achieved when building the draft landform, and centroids of material and void for material movement planning.

The Natural Regrade module helps the user through the design process by conveniently organizing all the commands that design a draft landform using the GeoFluv™ approach on a 'dockable dialog box' that is activated by the Design GeoFluv Regrade command. When this command is selected from the Natural Regrade menu, the dockable dialog box appears on the screen with all the GeoFluv™ design steps organized in a generally left-to-right and top-to-bottom sequence that leads the user through the design process. As a further aid to design sequencing, subsequent GeoFluv™ design inputs/commands are inactive on the dockable dialog box until the prerequisite step has been made. Finally, the commands automate and integrate as many of the calculations as possible to relieve the user of the burden of repetitive command steps.

The user can focus his design energy on testing alternative designs for enhanced suitability to site-specific conditions. Those site-specific conditions can include post-disturbance land use considerations, community relations, equipment constraints, material constraints, bond costs, visual aesthetics, etc. The resulting three-dimensional surface map can be exported in a variety of electronic formats to other programs, or printed as two-dimensional hard copy. The completed design can be taken to the construction site using survey and stakes, or output electronically to GPS and laser-guided construction equipment to further promote project efficiency. The designed topography can then be constructed with available equipment and earth materials.

Discussion of Input Parameters

GeoFluv™ helps the user create a stable landform based on minimal local input variables. These include site elevations (from a survey grid), a GeoFluv™ project boundary, a local stream base level to which the area within the GeoFluv™ boundary drains, a desired drainage density, design maximum discharge velocity, precipitation from the 2-yr, 1-hr and 50-yr, 6-hr storms, and runoff coefficient. The user will also select a desired cut/fill balance tolerance. Figure 3 shows an example of the minimal input data needed for the software to design the landform using this fluvial geomorphic approach.

![Figure 3. Example of Setup tab input dialog box](image-url)
The user can then edit this idealized landform for any number of reasons. The site may have boundaries that must be avoided. The user may want to bend a channel around an archaeological or historic site, or local landmark. The user may want to alter slope aspects to promote vegetation diversity, wildlife niches, or to harvest moisture by retaining snow. Aesthetic considerations, such as view sight line, may prompt the user to edit the draft landform. Material movement planning may require the user to evaluate factors including the cut/fill balance and haul distances associated with various alterations of the draft landform. The user may wish to create several interim landform designs leading to the final design for submission for incremental reclamation bonding. The ease and speed by which the software creates a draft design solution facilitates these and other edits. The Natural Regrade module frees the user to focus on site-specific design considerations and finding an optimal solution to creating a stable site landform, rather than being immersed in ponderous calculations for each subwatershed. Following the discussion of input parameters below, the Settings button default settings on the Setup tab will be explained. These settings are one way that the draft landform can be edited.

**Drainage Density and Channel Pattern**

The drainage density input is the valley length (without meanders) divided by the subwatershed area (Dunne and Leopold, 1978). Its units are length over area (L/L^2). Convenient U.S. units for landscape design work are feet/acre. This value will vary depending on factors such as earth materials, slope aspect, storm intensity, and vegetation type and coverage.

Drainage density is important because it represents the subwatershed size that will be stable for the local conditions. Drainage density and the ridges that form between channel meanders work together to break up the landform into many small subwatersheds, as can be seen in the natural subwatershed shown in Figure 4. The subwatersheds minimize both slope length and catchment area and thereby minimize erosion.

![Figure 4. Natural "A" channel meanders and ridges break slope length into a series of subwatersheds](image)

The drainage density is an expression of the amount of erosion that has occurred in the watershed. In a stable watershed, it represents the state at which sediment supply and water runoff are balanced in a state of dynamic equilibrium. Designing the landform using an appropriate drainage density for the project area conditions is an important first step toward achieving a stable landform design.

Watersheds may be disturbed in different ways and those affect reclamation planning differently. For example, mining may break up consolidated rock in the watershed and replace it with unconsolidated material. The result of this change on watershed reclamation design is often a marked change in channel pattern. Channels exploit weak portions of consolidated rock and tend not to form on more resistant portions, that is, the channel pattern has structural control. In the disturbed, unconsolidated material, the channels may form anywhere. Streams that previously had patterns that followed cracks in the consolidated rock can now form a more random pattern in the unconsolidated material. A different drainage pattern with greater drainage density may be expected in the unconsolidated, disturbed material for these reasons.

The effects of land leveling, whether for road building, urbanization, agriculture, or other purpose, may be nearer to the land surface and may not affect structural rock as much as an activity like mining might. The adverse affects of these land disturbances can still be unacceptable. Often these activities result in a decrease in drainage density and associated diversion of runoff from several watersheds into another watershed that is not adjusted to that flow.
Runoff water may accumulate in undesirable parts of the leveled land and an undersized receiving watershed may respond to an increased flow with erosion and excess sediment production. Reclaiming these lands disturbed by leveling with an appropriate channel pattern and drainage density can mitigate the effects of the prior disturbance.

GeoFluv™'s default drainage pattern is a dendritic pattern, because this "branching tree" pattern is the type that typically forms in unconsolidated materials (Bloom, 1978; Dunne and Leopold, 1978), such as those existing at a disturbed site. Drainage patterns other than the dendritic pattern generally express structural controls related to rock (or soil) mineralogy. Streamflow will not tend to maintain variation from the dendritic pattern when reclaiming unconsolidated materials without reestablishment of a structural control, e.g., rock-lined stream banks. Installing structural controls will add cost, will establish a point of weakness subject to attack by flowing water, and can cause disruption in the flow regime up- and downstream of the structure that will require compensation in the channel designs there.

**Determining appropriate reclamation drainage density**

GeoFluv™ suggests a default drainage density value, but the user can, and must, determine site-specific values to achieve landform stability comparable to surrounding natural land. By using empirically determined drainage density values in GeoFluv™'s input, the user can have a very high degree of confidence that the resulting design will behave similar to the areas from which the drainage density measurements were taken.

The user can determine a desired range of site-specific drainage density values. Local drainage density measurements taken from the undisturbed land with earth materials similar to the project area, and from nearby areas with earth materials that are similar to the project's disturbed earth materials, can define the range. The drainage density measured on undisturbed earth materials provides a lower end-of-range value, while the drainage density measured on nearby areas similar to the project's disturbed materials provides an upper end to the range of desirable drainage density input values.

The recommended procedure for determining drainage density values is to visit the field site with a map and to mark the location and length of each valley feature that, if it were to erode into a finished reclamation landscape, would be large enough to be considered undesirable. Many of these features that will be identified in the field would not be apparent when examining a 7.5 minute quadrangle. It is important to recognize that when different individuals determine drainage density values for the same stable watershed, their results will vary. One individual may map a slightly smaller feature and generate a greater drainage density value than another observer, or vice versa. For this reason, it is recommended that the same individual make all the determinations for design consistency.

**Entering Drainage Density Values**

The user draws a GeoFluv Boundary and sketches a draft channel pattern inside the boundary. The appropriate pattern for unconsolidated, disturbed material is typically a dendritic pattern. The channels should be spaced so as to divide the GeoFluv™ work area into roughly equal portions. The user then identifies the GeoFluv Boundary in the Setup tab by pressing the Select GeoFluv Boundary button and then selecting the boundary on screen with the cursor. The software calculates and displays the watershed area.

The user then clicks on the Select Main Channel button to identify which channel segment in the drainage pattern will collect discharge from all the tributary channels and convey it out of the watershed at the watershed's base level. Regrade will display on the Output tab the length of the main channel selected and calculate the GeoFluv™ work area drainage density that the user has sketched. If the reclamation drainage density is too low, the natural watershed response would be to erode material until the appropriate drainage density is achieved. If the software's indicated value is too low as compared to the desired design value, the user can lengthen or add channel segments until the desired drainage density is attained. Conversely, if the indicated value is too high, the user can shorten or remove channel segments. If the design drainage density is too high, erosion is not likely, the landform may even be more resistant to erosion, but earthwork costs would increase beyond that which is necessary to create a landform as stable as surrounding natural lands.

**Sinuosity**

Sinuosity is the ratio of channel length to valley length. A stream flowing in unconsolidated material will typically
begin to meander as it flows down slope. Because of this, the distance that the stream flows is greater than the
straight line distance from the stream's head to its mouth. Sinuosity is calculated using units of length over length
(L/L) and is a dimensionless value greater than 1.0 when any meandering is present. After the user has input the
channel pattern and accepted a pattern with the desired drainage density, this software will then draw a draft channel
pattern with suggested sinuosity appropriate to the channel slope. Channels on steeper slopes generally are less
sinuous than those on lower gradients in stable land forms. The user may edit the draft channel's sinuosity value
using the Channels tab's 'Current Channel Settings...' button.

Channel Longitudinal Profile
Following the development of the channel pattern with sinuosity, GeoFluv™ calculates channel longitudinal profiles
for each channel in the draft drainage pattern. The longitudinal profile of a natural channel is typically concave
(Dunne & Leopold, 1978), steeper gradient in the headwater reaches and lower gradient near the channel mouth.
That is because the headwaters of the watershed have less area, and therefore generate less runoff and erosive energy
than the reaches near the channel mouth. Steeper channel gradients can be stable in the upstream reaches and lower
channel gradients are appropriate in the downstream reaches for this reason. Stable slope profiles also tend toward
this profile as can be seen in Figure 5.

![Figure 5. Concave longitudinal profiles in stable natural slopes](image)

Determining appropriate channel reclamation longitudinal profile
GeoFluv™ designs the longitudinal profiles for the draft landform to grade concave profiles to each local base level.
For example, the main valley bottom channel in the draft GeoFluv Boundary work area grades to the user-input
local base level (the lowest elevation in the design's main channel, typically where all runoff leaves the GeoFluv
Boundary). GeoFluv™ grades each valley wall channel, at its confluence with the main valley bottom channel,
to the main valley bottom channel slope at their confluence. The headwater slope for the design profile can be
automatically determined by the elevation of the design's GeoFluv™ Boundary and a default distance from that
boundary over which the ridgeline can have a convex profile and be stable, or can be user specified using the
Channels tab's 'Current Channel Settings...' button.

Entering Longitudinal Profile Values
When the user identifies the GeoFluv Boundary in the Setup tab by pressing the Select GeoFluv Boundary button
and then selecting the boundary on screen with the cursor, GeoFluv™ uses the boundary elevation to calculate a
channel head elevation for each channel in the watershed from the Surface for Elevations file. The user specifies
the three dimensional surface file that GeoFluv™ will use as a beginning surface from which to create its fluvial
geomorphic landform design using the Surface for Elevations button. Examples of Surface for Elevations include
existing post-disturbance topography designs or pre-disturbance topography. The user can type in the file path and
name or use the browse button to help locate the desired file. The user may also enter Head Elevation and Base
Elevation values using the Channels tab's 'Current Channel Settings...' button manually to gain accuracy; this is
highly recommended for the base level elevation. The base level elevation has great effect on watershed response
and an interpolated elevation may vary by several feet from the actual elevation. If the sketched channel begins beyond the default maximum distance from the GeoFluv Boundary, a pop-up warning will advise the user of this condition. The user may then either extend the channel to be within the default value or reset the default distance using the Settings button if local conditions permit a greater distance without erosion. The result of GeoFluv™'s longitudinal gradient solution is a network of sinuous channels that have concave profiles and smoothly transition from steeper headwater gradients to the gradient at the design watershed's local base level elevation. Figure 6 shows an example of a natural stable network of slopes and channels with concave longitudinal profiles graded together from steeper ground to a lower gradient valley bottom.

![Figure 6. Stable natural channels and slopes grade from steep to flatter gradient by a network of concave longitudinal profiles](image)

The Profile button allows the user to review the design longitudinal profile for the current channel. It displays the beginning and ending channel elevations, the profile, and by moving the cursor, stationing is depicted along the profile along with the elevation and slope at that station. The viewer allows for vertical exaggeration to aid work on lower relief channels. The viewer also has toggle settings for pan/zoom and tick mark options. The Natural Regrade drop-down menu has powerful editing commands for channel and slope longitudinal profiles for special situations.

**Channel Cross-section**

GeoFluv™ calculates the channel cross-sectional profiles for channel reaches. The bankfull width (Dunne and Leopold, 1978) (Rosgen, 1996) for the mean annual flow is used to create a hydrologically balanced cross section. GeoFluv™ uses the input runoff coefficient, maximum water velocity, 2-yr, 1-hr storm precipitation, and width to depth ratio values to create this cross section. As the watershed area increases downstream, more water is present in the channels and the channel cross-sectional area must increase to convey the discharge within the user-specified design velocity range. Other channel pattern dimensions, i.e., meander length, meander belt width, radius of curvature, related to the bankfull discharge (Williams, 1986) increase concurrently. GeoFluv™’s cross-sectional area increase occurs simultaneously with the other channel dimensions. Channel flood-prone area has been related to a 50-year recurrence interval event (Rosgen, 1996) and GeoFluv™ uses this value to design the flood-prone area of the channel. The resulting dimensions define the channel banks for the draft landform. The designer can get cross section information by station for any channel in the GeoFluv design using the Channels tab’s Report button. The range of design dimensions can also be seen using the Output tab’s Summary Report button. A reviewer can get cross section information by station for any channel in the GeoFluv™ design from a completed drawing using the Natural Regrade dropdown menu’s GeoFluv™ Channel Cross-section Report command.

**Ridges, Slopes, and Volumes** GeoFluv™ designs ridgelines between the channels at elevations that create side slopes less than a default 5:1 gradient for the draft landform. The Preview button in the Output tab will display the location of the main ridges, and the subridges and subridge valleys that form around the channel bends. The user may alter the elevation and placement of the ridgelines to adjust slope gradient and material balance. The Draw Design Surface button in the Output tab is used to contour the ridgelines and channels to reveal the draft landform. The Save Design Surface button in the Output tab saves the landform drawing as a file.

Figure 7 shows a reclamation project midway through construction that used this fluvial geomorphic approach. The mine pit highwall that ends at the graded gray spoil used to continue trending to the right of the figure and then turned ninety degrees toward the lower right of the figure. The steep slope reclamation with four subwatersheds immediately to the right of the end of the pit is the same slope shown in Figure 2 above. This project was designed over a period of months without the benefit of the computerized software; using Natural Regrade with GeoFluv™,
the design time would be measured in hours.

Figure 7. Fluvial geomorphic reclamation is underway at the 115-acre Cottonwood Reclamation Project, Farmington, New Mexico. Gray colored material is mine spoil being graded using fluvial geomorphic approach. The U.S. Department of the Interior awarded San Juan Coal Company "National" and "Best of the Best" reclamation awards for 2004 for this project.

GeoFluv™ calculates and displays the material balance needed to create the draft landform. The GeoFluv™ design's material balance is calculated by comparing the GeoFluv™ design surface to the surface file identified as the Comparison Surface. The user could compare the Design Surface to the pre-disturbance surface, another post-disturbance reclamation surface design, the existing disturbed surface, or other surface file. Figure 8 is an example output dialog box that compares the cut to the fill needed to create the landform.
Figure 8. Output dialog box gives immediate cut/fill balance to guide landform design editing

Note that the Output tab also displays the overall drainage density with the GeoFluv work area, which can be compared with the current channel drainage density. The user can compare the drainage density that is displayed in the Channels tab for each channel's subwatershed to the overall watershed drainage density to verify that the drainage density is uniform throughout the watershed. Subwatersheds that have too great or small drainage density values can be corrected by editing ridges or channels to vary areas or channel lengths.

The Output tab and the Summary Report show whether or not the balance is within the user-specified tolerance. The Summary Report button in the Output tab generates a report for the channel showing the design parameter values of the channel and valley slopes. The report also displays the parameter values for natural channel types in the Rosgen stream classification scheme for ready comparison.

The draft landform is an idealized solution to creating a stable landform according to fluvial geomorphic principles based on the user-specified input values. The user may modify the draft landform, for example to reduce the fill volume by lowering a ridgeline using the Edit Longitudinal Profile or Auto Longitudinal Profile commands, and the software can almost instantaneously recalculate the cut/fill balance to meet the user's design.
The DWG tab lists the tools for analyzing the Design Surface as it is represented in the drawing in the channels and ridges layers (GF_Channels and GF_Ridges by default). These are the same commands that are in the Natural Regrade menu plus the addition of Save Design Surface TIN. The Save Design Surface TIN command will save a TIN file of the current Design Surface (as it is represented in the drawing) and is simply the built channels and ridges within the GeoFluv boundary. The Editing Mode toggle helps to clarify the difference between editing a GeoFluv input and editing a Design Surface in the drawing.

**The Fluvial Geomorphic Characteristics of the Draft Landform**

The fluvial geomorphic characteristics of the draft landform are those that are compatible with unconsolidated materials placed at various slopes, subject to particular storms, and considering special limitations of typical reclamation sites. Those special limitations include a relatively thin topsoil veneer over mixed earth materials (spoil), equipment limitations (e.g., equipment grading capability versus design grading requirements, ability to traverse steep slopes), and desire to minimize cost and maintenance.

The GeoFluv™ fluvial geomorphic approach to building stable reclamation landforms is centered on creating a network of ephemeral drainage channels and associated slopes that are in a state of quasi-equilibrium, i.e., that are "stable." Natural ephemeral channels are the landscape's response to runoff events. By definition, they flow now only in response to direct precipitation. However, they may have formed in response to greater precipitation during wetter climatic conditions, including glacial periods, when they may have flowed as intermittent or even perennial streams. Considering that, their water and sediment transport characteristics would be expected to be consistent with streams that flow perennially in the present climate.

For this discussion, we will use the Rosgen classification scheme for natural channels. The Rosgen scheme classifies perennial streams according to major types based on slope, width to depth ratio, entrenchment ratio, and sinuosity (see glossary for definitions), and stream bed material particle size (1 through 6, where 1=bedrock and 6=silt/clay). The Rosgen classification scheme describes natural channels as major types A through G using characteristics of multiple and single thread channels that form in different geologic settings.

Slope is generally considered the dominant characteristic, and only the type A and A+ channels are associated with
slopes greater than -0.04. For this reason, the A and A+ channel types have a place in many reclamation landscape designs.

Some of these channel types, such as the multiple-thread D and single-thread F and G, are associated with high bank erosion rates and sediment transport and deposition. They tend to exist as transitional channel forms as the channel moves towards a more stable type and for this reason are not favored for use in a stable reclamation landscape design.

The B type is a step-pool stream with low sinuosity, with the steps typically formed by resistant rock strata and narrow rock canyon walls limiting sinuosity. Because both of these structural elements are typically gone in a reclamation landscape, the B type channel is not favored in stable reclamation landscape design either.

The remaining major types, the C and E, differ mainly in their width to depth ratios and sinuosities, and the stable E type's association with dense bank vegetation. The low width to depth ratio of the E-type develops where the combination of cohesive bank material and a dense network of roots from bank vegetation are present. The E type channel is stable, but is very sensitive to disturbance of its bank material and vegetation. The C type has a tendency toward lateral migration through the process of erosion at the cut bank and deposition on the point bars, a tendency that is also exacerbated by bank material and vegetation disturbance.

From this discussion, it can be concluded that the characteristics of the A, C, and E major types have advantages for stable reclamation channel design. Further, the major channel types do not exist as distinct and separate entities, but in an evolutionary continuum from one type to another. For example, a B5c stream would have the major characteristics of a B channel with dominantly sand-size material, but its flatter slope, greater sinuosity, and width-to-depth and entrenchment ratios, would be tending toward those associated with type C streams. The flatter slope of this stream type combined with its greater sinuosity can allow it to transport and balance its water and sediment loads by channel geometry and not require the structural drops associated with the major B-type's step/pool sequences. Its width-to-depth and entrenchment ratios are such that all but extreme events may remain within a flood prone area within its channel banks. When its hydraulic design is correct and its banks are sufficiently protected by vegetation, natural appropriate channel roughness, and bank protection such as rock deflectors or J-hook vanes, this channel type can convey water and sediment discharge with minimal changes to the channel pattern. In other words, the channel can maintain its course and not erode into its banks and through the relatively thin veneer of topsoil because sediment transport and deposition occurs within the channel. When floods greater than the flood-prone capacity (based on entire 50-year, 6-hr recurrence interval precipitation introduced to the channel instantaneously in the GeoFluv™ approach) occur, the additional discharge energy can be rapidly dissipated on an adjacent floodplain.

The default channel-type settings create type A and A+ channels at slopes greater than -0.04 and type Bc channels for slopes less than -0.04 using lower-range channel geometry values for these types. The user can also optionally choose to randomly vary the channel geometry values within the acceptable range using the Channels tab's "Current Channel Settings..." button. GeoFluv™displays the channel geometry values for all channels and reaches of longer channels in the watershed in the Summary Report. The user can then edit the channel settings within the ranges of value appropriate to the default channel types or vary the settings to use different channel types.

Links with Other Software

The Natural Regrade with GeoFluv™ computerized landform design can further improve operational efficiency by interfacing with computerized machine guidance software. The GeoFluv™landform design can literally be sent from the designer's computer screen to the machine operator's guidance screen by radio transmission and the designs can be implemented "on the fly". Design editing can also be done expeditiously. For example, if unforeseen conditions emerge, such as shallow bedrock near the edge of disturbance that hinders a dozer cut, the designer can keep the operator working elsewhere, adjust the channel's and related subwatershed design during the shift, and return the operator to work on the revised design.

Additional efficiency can be achieved by integrating the computerized landform design with software, such as Carlson Software's Productivity Tools, that provide real-time equipment monitoring and data capture during construction.
This software determines material movement volumes and distances over time for associated equipment. The information that this software provides to decision makers was previously not available and can help them identify the most efficient operational methods for maximum cost savings. Carlson Telescope and Starnet are two office monitoring products that allow for viewing heavy equipment in real-time, as well as enabling two-way real-time file transfer.

GPS guidance and machine control software can virtually eliminate the need for survey stakeout in the field and greatly enhance production efficiency. The machine operators can follow the project design and complete it to grade on their own as they work. Carlson Software makes Carlson Dig for excavators and shovels, Carlson TruckPro for haul trucks, Carlson Autograde for dozers, loaders, compactors, motorgraders, scrapers, foreman trucks, etc., Carlson Drillstar for drills, and Carlson Grade that allows cross-platform, multi-equipment functionality.

The link to the RIVERMorph two-dimensional data collection and channel design software allows for near instantaneous conversion of the RIVERMorph user's design into a three-dimensional design. The RIVERMorph two-dimensional software follows natural channel design methods, as developed and taught by Dave Rosgen. The user can render and view the three-dimensional channel design made in Natural Regrade with all the Carlson capabilities, rotating, tilting, quick volume calculations of earthwork or pools, etc. The RIVERMorph designs are made into .tin files by default and can be also be made into .flt or grid file formats. The .flt and .tin file formats are commonly used by machine control software, so the Natural Regrade design is ready to load into machine control equipment; construction can begin without additional surveying or staking! The RIVERMorph designs can be inserted into any GeoFluv™ design to produce an integrated natural river and upland landform design.

Software Compatibility

The Natural Regrade module with GeoFluv™ is a module of the Carlson Civil / Survey family. As such, it functions in tandem with the widely-used AutoCAD drafting software. Carlson Civil / Survey is application software for the civil engineering, surveying, mine engineering, and GIS disciplines that use AutoCAD as the graphics engine and drawing editor. Carlson Civil / Survey's system requirements are no greater than that of the AutoCAD version with which it operates and will work with any AutoCAD-based product from AutoCAD 2000 through AutoCAD 2009 as well as IntelliCAD.

Data Entry

The Carlson Civil / Survey software accepts data downloads from any data collector, or other data file. Once the data are imported, they are stored as a coordinate (.crd) file. The entire Natural Regrade module project can then be designed from the .crd files without leaving Carlson Civil / Survey.

Summary

Computerization of this fluvial geomorphic approach to land reclamation makes the applied science from a relatively obscure body of knowledge available to a wide range of users. The approach helps the designer to build the landform that would tend to form under the existing physical conditions. The benefits of this approach include stability against erosion, hydrologic function and plant and animal habitat that are similar to undisturbed natural lands, lower construction cost for steep slopes, mitigation of maintenance concerns, and improved aesthetics. This approach also links with machine control and management software to further improve the efficiency of land reclamation. Table 1 summarizes the advantages gained by using the Natural Regrade software with GeoFluv™ to reclaim disturbed lands.
Table 1. Comparison of old methods of reclamation to landscape designed using this computer-aided fluvial geomorphic design method.

<table>
<thead>
<tr>
<th>Old method</th>
<th>Natural Regrade software with GeoFluv™</th>
</tr>
</thead>
<tbody>
<tr>
<td>Based on conveying a single extreme discharge event</td>
<td>Based on all discharges</td>
</tr>
<tr>
<td>Conveys only water discharge effectively at lower Q</td>
<td>Natural channel morphology conveys water and sediment discharge; hydrologic balance</td>
</tr>
<tr>
<td>Requires expensive off-site earth material, e.g., rip-rap</td>
<td>Built with on-site materials</td>
</tr>
<tr>
<td>Expensive on steep slopes</td>
<td>Cost is significantly lower than gradient terraces and down drains on steep slopes</td>
</tr>
<tr>
<td>Requires long-term maintenance</td>
<td>Self-maintaining</td>
</tr>
<tr>
<td>Requires maximum backfill to lower slopes</td>
<td>Can reclaim steep slopes in stable and suitable configurations, save money on material moving</td>
</tr>
<tr>
<td>Provides minimal slope aspect diversity</td>
<td>Increased slope aspect diversity promotes vegetation success and animal habitat</td>
</tr>
<tr>
<td>Visual affect</td>
<td>Natural beauty</td>
</tr>
<tr>
<td>Rigid design sideboards limit landscape alternatives</td>
<td>Landscape designs can vary and provide alternatives</td>
</tr>
<tr>
<td>Regulatory agencies not satisfied</td>
<td>Regulatory agencies embrace</td>
</tr>
</tbody>
</table>


These benefits will be realized for those designing mine reclamation, subdivisions, golf courses, ski areas, parks, etc.; any site where the land surface has been disturbed. For example, storm water catchments do not have to be a rectangular pond surrounded by a chain link fence, but can serve the storm water control purpose and also be a hydrologically functioning and esthetically pleasing park. This technology will help designers, developers, and regulators evaluate more options, help companies save production and bond dollars, and promote better land reclamation and use.

Documentation References


Bugosh, N. 2003. Innovative reclamation techniques at San Juan Coal Company (or why we are using fluvial geomorphic principles and otherwise doing our reclamation differently), at Rocky Mountain Coal Mining Institute national meeting, July 2003, Copper Mt., Colorado.

Bugosh, N. 2003. Stream channel design reclamation - The fluvial geomorphic approach to hydrologic reclamation, pre-conference workshop at joint conference of the Billings Land Reclamation Symposium and the Annual Meeting of the American Society of Mining and Reclamation, June 2003, Billings, MT.

Bugosh, N. 2002. Reclamation using fluvial geomorphic principles (or why we are doing our reclamation differently), at Office of Surface Mining Bond Release Forum, August 2002, Bismarck, ND.


Bugosh, N. 2002. Fluvial geomorphic principles applied to mine reclamation at New Mexico meeting of Rocky Mountain Coal Mining Institute, April 2002, Farmington, NM.

Bugosh, N. 2000. Fluvial geomorphic principles applied to mined land reclamation at OSM Alternatives to Gradient Terraces Workshop, January 2000, Farmington, NM.

Natural Regrade Menu

Design GeoFluv Regrade

The Design GeoFluv Regrade command on the Natural Regrade Menu is used to open the dockable dialog box and access the main GeoFluv™ design commands.

![GeoFluv dockable dialog box](image)

The main GeoFluv™ input edit boxes, buttons, and commands are arranged in GeoFluv™'s main dockable dialog box in four tabs, Setup, Channels, Output, and DWG. The edit boxes and buttons are arranged in the input and operational sequence that the user will usually follow to make a GeoFluv™ design. The general order is left-to-right through the tabs and top-to-bottom within each tab. Prerequisite commands are further noted in the GeoFluv™ dockable dialog box by making prerequisite commands/inputs active (clear image) while subsequent command/inputs remain inactive (faded image) until the prerequisite step is performed.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gf  
**Prerequisite:** Polyline perimeter

Natural Regrade File

The File button at the top of the Design GeoFluv Regrade dockable dialog box provides a convenient way for the user to save GeoFluv™ projects. The File button can be clicked at any time. When the user left-clicks on the File button, the Open and Save Projects dialog box appears.

This dialog box gives the user the options to create a "New" GeoFluv™ project file, "Open" an existing GeoFluv™ project file, or "Save As..." a new project file. Saving the various designs as separate project files allows the user to
store and retrieve each design alternative with all of its settings intact. If the user creates a project file, either with the New button or the Save As button, then all changes made to that design will be saved automatically to the project file. If a project file is never selected, then the settings are lost when the drawing is closed or when the dockable dialog box is closed and a new drawing is opened.

Every line and point (and in general, "entity") has a name in AutoCAD. The GeoFluv™ project file remembers the names of the GeoFluv Boundary polyline and the valley bottom polylines that are in the drawing rather than storing complete copies of all the coordinates in those polylines. The advantage of this method is that when the GeoFluv Boundary or the valley bottoms change, the GeoFluv™ design will reflect the changes automatically and will never be inconsistent with the drawing.

*Natural Regrade* gives the user the ability to rapidly create many design alternatives according to fluvial geomorphic principles for a stable landform. The user can then compare the various GeoFluv™ landform design alternatives considering how well the designs satisfy land use objectives, and practicality and overall material handling costs. From these comparisons the user can decide on an optimal design. Saving the design alternatives as projects using the File button saves the user from having to repeat data entries.

**Natural Regrade Global Settings**

These settings include variables that will remain constant for a GeoFluv™ design, e.g., precipitation event values, and other detail settings specific to a GeoFluv™ design area that the user will typically not change for each design iteration.

The Settings button at the top of the Design GeoFluv Regrade dockable dialog box provides a convenient way for the user to access all these settings in one place. The Settings button is accessible at any time. Left-clicking on the Setup tab's Settings button opens the Natural Regrade Global Settings dialog box. Each of the settings is described below.

**Maximum distance between connecting channels (ft.):** This is a drawing setting that defines a maximum separation of polylines that *Natural Regrade* will recognize as channel polylines. The maximum distance should be set as small as the user can comfortably draw. The user types this value into the edit box. Some users may be able to hold and click the cursor more accurately than other users and this setting accommodates those differences.
Maximum distance from ridge line to channel's head (ft.): This is an essential local variable in the GeoFluv approach. It is the shortest distance from a ridgeline to the head of a stable channel. The user will determine this value, in the vicinity of the GeoFluv project, for stable landforms that developed in earth materials similar to the disturbed earth materials within the GeoFluv boundary. The value is a function of local factors including soil cohesiveness, vegetation canopy, cover, and root density, storm intensity and other climatic factors, and topographic relief. The user types this value into the edit box. The 80-foot default value is for an erosive semi-arid, high-altitude desert region in the southwestern United States.

Slope at the mouth of the main valley bottom channel (%): This setting, along with the Channels tab's "Advanced...Specify mouth elevation." setting, may be the most critical value to creating a stable final landform design using the GeoFluv approach. The GeoFluv design must integrate with upstream and downstream areas to achieve stability. That means that GeoFluv channel reaches must have longitudinal profiles that blend smoothly with up-and downstream channel reach profiles. The user will determine the slope downstream of the mouth of the main valley bottom channel by survey, e.g., a point every 25 feet for about 400 feet. The user can plot a longitudinal profile from these points and select an input value for the channel slope upstream that will blend smoothly into the downstream profile. The user types this value into the edit box.

In some cases, disturbance may continue for a great distance downstream of the GeoFluv boundary. In those cases, the user must determine the slope at the eventual downstream, undisturbed tie-in point, extend that profile upstream to the GeoFluv boundary, and specify a smooth tie-in slope value.

"A" channel sinuosity: This setting applies to channel reaches with slopes >0.04. The channel types that form in these steeper reaches have low sinuosity, <1.2. Steeper reaches may be expected to have lower sinuosity still. Sinuosity will typically increase as slope decreases (inversely proportional). This setting allows the user to specify a maximum sinuosity <1.2, which may be desirable in certain cases, e.g., for very steep, short channels the user may want to specify a lower value. The user types this value into the edit box.

"A" channel reach (ft.): This is an essential local variable in the GeoFluv approach, and reflects many of the same local variables as does "Maximum distance from ridge line to channel's head" above. It is one-half of a meander length. The user will determine this value for stable landforms, in the vicinity of the GeoFluv project, that developed in earth materials similar to those within the GeoFluv boundary. The user types this value into the edit box.

2-yr, 1-hr (in.) (see documentation): This is where the user inputs the precipitation value for the storm event that determines the bankfull channel dimensions and plan-view channel geometry. This is an essential local variable in the GeoFluv approach. The GeoFluv approach uses a 2-yr, 1-hr storm event to design these features for ephemeral upland channels, and it can be used for ungauged intermittent and perennial channels as well. The value can be typed into the edit box, or entered by using the Rain Map button for sites in the U.S. and Puerto Rico.
Clicking on the Rain Map button produces a dialog box in which the user will select the state or territory of interest, and the storm frequency and duration using dropdown menus. When the user selects a state or territory, Rain Map zooms in to that selection. The user then moves the cursor to the GeoFluv™ project area, left-clicks on it, and the interpolated value is entered into the "Rainfall (in.)" field in Rain Map. When the user clicks on the OK button at the bottom of the Rain Map dialog box, the dialog box closes and the rainfall value is automatically entered into the Natural Regrade Global Settings precipitation event edit box (next to the Rain Map button).

If the user has data from a stream gauging station sufficient to determine the discharge associated with an annual recurrence interval (bankfull) event, they can directly enter that value into GeoFluv™ using the "Channels" tab's "Advanced . . ." button and "Use manual Qpk.". The user is cautioned that increasing these values beyond the actual event value will not create a "design safety factor", but rather will create a channel that is not competent to transport sediment during more frequent, lower-discharge events, i.e., it will cause sediment deposition in the channel that can cause channel blockage, etc.

50-yr, 6-hr (in.) (see documentation): This is where the user inputs the precipitation value for the storm event that determines the flood-prone channel dimensions. This is an essential local variable in the GeoFluv™ approach. The user can input the value using methods discussed in the "2-yr, 1-hr" section above.

The dominant channel morphology has been shown to be related to about a 50-year recurrence interval event, rather than some extreme 100-year, 200-year, probable maximum, or other event. The GeoFluv™ approach uses an intense 50-year event to design the flood prone area of the channel and places the entire amount of the 6-hour storm into the channel instantaneously to calculate a peak discharge associated with extreme channel-forming events. All this discharge is contained within the channel banks in Natural Regrade’s default GeoFluv™ channel design. The user can also design a floodplain or terrace adjacent to the channel to accommodate greater discharges; when these are relatively wide the tremendous increase in cross sectional area allows the additional discharge to spread across the surface without causing undesirable erosion.

Target drainage density (ft./ac.): This is an essential local variable in the GeoFluv™ approach. It is the total valley length divided by the area within the GeoFluv™ boundary. The user will determine this value for stable landforms, in the vicinity of the GeoFluv™ project, that developed in earth materials similar to those within the GeoFluv™ boundary. (Refer to Introduction section for more detail.) It is a function of local factors including soil cohesiveness, vegetation canopy, cover, and root density, storm intensity and other climatic factors, and topographic relief. It is the extent to which a drainage network will develop given those local factors to achieve a stability
comparable to surrounding land areas. The user types this value into the edit box.

**Target drainage density variance (%)**: This is an essential local variable in the GeoFluv™ approach. It captures the range of acceptable drainage density values for the GeoFluv™ project area based on the range of locally-measured drainage density measurements as described above and in the Introduction section. For example, if the lowest drainage density value that the designer has determined can be stable is 80 feet/acre and the highest drainage density value that is measured in similar local earth materials is 120 feet/acre, the user could set a target drainage density value of 100 feet/acre and a target drainage density variance at 20 percent to capture that locally-determined range of 80 to 120 feet/acre. The user types this value into the field.

**Force ridges to be lower than GeoFluv boundary**: This toggle setting allows the user to specify if any point on a main ridge line can be higher than where the ridge line meets the GeoFluv™ boundary. A main ridge line in the GeoFluv™ approach is a ridge that defines a subwatershed divide within the GeoFluv™ boundary. When this box is checked (toggled on), the elevations on the main ridgeline will all be lower than the elevation on the GeoFluv™ boundary where the main ridgeline intersects the GeoFluv™ boundary. When this box is left blank (toggled off), a ridgeline may have a high point of greater elevation than the GeoFluv™ boundary, e.g., creating a knob or butte feature. In this case all runoff will still remain within the GeoFluv™ boundary and exit at the mouth of the main valley bottom channel. The feature allows the user to create a topographic feature within the GeoFluv™ boundary that may vary from the pre-disturbed surface, but is still a stable landform. This can be used to minimize the movement of piles of earth material when creating a stable landform design.

**Angle from subridge to channel's perpendicular, upstream (deg.)**: This is a local variable in the GeoFluv™ approach. This is the angle that subridgelines make in the upstream direction from the valley bottom to the main ridgeline. The user will determine this value for stable landforms, in the vicinity of the GeoFluv™ project, that developed in earth materials similar to those within the GeoFluv™ boundary. Setting this value similar to surrounding stable landforms will help the GeoFluv™-designed landform blend harmoniously with surrounding natural landforms. Natural Regrade will automatically create all the subridges in the draft landform using this value. The user can edit individual ridgeline orientations from the draft landform to suit site-specific design needs, however, Natural Regrade's ability to create the subridges and subridge valleys saves the user a tremendous amount of design time when producing draft landform designs. The user types this value into the edit box.

**North or East straight-line slopes (%)**: This setting allows the user to specify a global target for a maximum ridge-to-toe slope profile steepness on the north- and east-facing slopes (between 315 and 135 degrees). The north and east-facing slopes are generally steeper in natural landforms because they get less sun and can retain more moisture, factors that favor tree growth and its associated root-binding of slope soils. Because the slope faces can contain an infinite degree of aspects in the GeoFluv™ approach, Natural Regrade does not produce the identical slope angle for all north or east-facing slopes with this setting; it is rather a best-fit slope adjustment toward the specified target value. The user should remember that changing the slope on one side of a ridgeline will affect the slope on the other side of the ridgeline. The user types this value into the edit box.

**Maximum straight-line slopes (%)**: This setting allows the user to specify a global target for a maximum ridge-to-toe slope profile steepness on all slopes within the GeoFluv™ boundary. As in "North or East straight-line slopes" above, it is impractical for Natural Regrade to control every area of the design with this setting; it is a best-fit slope adjustment toward the specified target value. The user should remember that changing the slope on one side of a ridgeline will affect the slope on the other side of the ridgeline. The default value is 33 percent because agricultural machinery commonly in use for land reclamation has difficulty working across steeper slopes. The user types this value into the edit box.

**Maximum cut & fill variance (%)**: This setting allows the user to specify a global maximum for the cut and fill material balance for the GeoFluv™ design surface as compared to another surface, e.g., Pre-disturbed surface. A value of 100 percent means cut and fill are balanced. A value of 125 percent means that there is 25 percent more material that needs to be removed to create the surface than there are areas requiring fill. The user types this value into the edit box.

**Minimum cut & fill variance (%)**: This setting allows the user to specify a global minimum for the cut and fill material balance for the GeoFluv™ design surface as compared to another surface, e.g., Pre-disturbed surface. A value of 100 percent means cut and fill are balanced. A value of 80 percent means that there is 20 percent less
material that needs to be removed to create the surface than there are areas requiring fill. The user types this value into the edit box.

**Cut swell factor:** This setting allows the user to specify a global swell factor for cut material from bank volume to loose volume. A value of 1.000 means that the loose volume is the same as the bank volume. A value of 1.120 means that the excavated loose material fills 12 percent greater volume than did the same material in place before excavation. The user types this value into the edit box.

**Fill shrink factor:** This setting allows the user to specify a global shrink factor for fill material from loose volume to fill volume. A value of 1.000 means that the fill volume is the same as the loose volume. A value of 0.900 means that the filled and settled/compacted material fills 10 percent less volume than did the same loose material after excavation. The user types this value into the edit box.

**Setup Tab**

The Setup tab is used for work that defines the watershed boundary, establishes the general channel pattern, calculates the watershed drainage density, channel head and mouth elevations, channel slopes, and defines the three dimensional surfaces that GeoFluv™ will use to create the stable draft design watershed and calculate the material balances for the design.

**Select GeoFluv Boundary**

The user defines the boundary polyline that they have drawn to outline the GeoFluv™ design area on the drawing. GeoFluv™ will automatically calculate and display the watershed area inside the defined boundary. (This area is only the area to which the GeoFluv™ design will be applied. If additional undisturbed or previously reclaimed area lies upstream of the GeoFluv™ design area, runoff from that additional area can be added into the design in the Channels tab using the Add Area window.) The default area units are acres, but metric units can be selected in the Carlson Drawing Setup dialog box accessed through the Carlson toolbar at Settings/Configure/Drawing Setup (use of consistent units in a drawing is recommended).

**Command Prompt:**

Select GeoFluv boundary polyline. Select objects

The user moves the cursor to cross the GeoFluv Boundary polyline anywhere along its length and left-clicks to define the GeoFluv Boundary to the Natural Regrade module.

The command prompt reads, "New GeoFluv boundary has been accepted.", if the cursor has clicked on a closed polyline, the watershed area is calculated and displayed, and the Select Main Channel button on the Setup tab
becomes active. The command prompt reads, "GeoFluv boundary polyline must be closed." if the polyline the user selected is not closed, and the watershed area is not calculated and displayed, and the Select Main Channel button remains inactive.

**Select Main Channel**

The user defines the channel that is the main valley bottom channel draining all discharge to the watershed's base level. The user also specifies the point at which the main valley bottom channel makes its transition from a lower gradient (<0.04) channel type to a steeper gradient (>0.04) channel type. The Select Main Channel button becomes active after the user has selected the GeoFluv Boundary polyline.

**Command Prompt**

Select main valley bottom channel polyline. Select objects: The user moves the cursor to cross the main valley bottom channel polyline anywhere along its length and left-clicks to define the main valley bottom channel to GeoFluv™.

When executed correctly, the command prompt reads, "Choose the forced transition point between channel types. (Press Enter to find automatically.)" if the cursor has covered and left-clicked a closed polyline. The user then either specifies the forced transition point between channel types (reaches with >-0.04 and <-0.04 slope) by placing the cursor crosshairs on the valley bottom polyline and left-clicking, or presses enter to allow GeoFluv to find a transition point based on the Pre-Disturbed Surface file elevations.

**Command Prompt:**

Choose the forced transition point between channel types: The user moves the cursor crosshairs to the point at which he wants the main valley bottom channel to transition to its steeper (A/Aa+ type) reach and left-clicks to select that point. Alternately, the user can press the Enter key and GeoFluv will determine a transition point using the Pre-disturbed file data. When executed correctly, the main channel length and drainage density for that channel in the entire GeoFluv Boundary area are calculated and displayed in the "Data for main channel:" fields and the reads, "Main channel has been accepted." GeoFluv will compare this drainage density to the target value in Settings and, will highlight the value in red if it is too low or will highlight the value in green if it is within the acceptable range. If the value is too low, the user can lengthen the main channel, decrease the GeoFluv Boundary area, or add more channels using the Channels tab's Add button.

The command prompt reads, "Main channel polyline must not be a closed polyline" if the polyline the user selected is closed, and the channel length is not calculated and displayed. The command prompt reads, "Main channel must cross watershed boundary" if the user has clicked on a segment that does not leave the watershed at its base level, and the channel length is not calculated and displayed.
Data for Main Channel

The "Data for main channel" fields display information that GeoFluv™ will use to create the main valley-bottom channel that conveys all runoff from within the GeoFluv Boundary downstream to the base level elevation. The GeoFluv™ design is built headwards from the base elevation.

Head Elev. (ft.) displays the elevation at the head of the main valley bottom channel. GeoFluv™ can determine a head elevation from the three-dimensional surface entered using the Pre-Disturbed Surface button. The head elevation will appear in this field when the user enters a three-dimensional surface file. Alternatively, the user may specify an elevation using the Channels tab's Advanced button to access the "Specify head elevation" option on the 'Channel "main" Advanced Settings' dialog box.

Base Elev. (ft.) displays the elevation at the that is the local base level for the main valley bottom channel. GeoFluv™ can determine an approximate base-level elevation from the three-dimensional surface entered using the Pre-Disturbed Surface button. The approximate base-level elevation will appear in this field when the user enters a three-dimensional surface file. This elevation is adequate for creating draft GeoFluv™ designs, but the user must use an accurate field-surveyed base-level elevation for the final design. The user may specify the field-surveyed base-level elevation using the Channels tab's Advanced button to access the "Specify mouth elevation" option on the 'Channel "main" Advanced Settings' dialog box. (See also Settings tab's "Natural Regrade Global Settings", Slope at the mouth of the main valley bottom channel (%) for this related critical setting.)

Valley Length (ft.) displays the length of the main channel that the user has identified using the Setup tab's Select Main Channel button. After the user inputs the transition point from the main channel's headwater reach (slope >-0.04) and its valley bottom reach (slope <=-0.04), GeoFluv™ will display the length of the selected main channel in this field and use the value to calculate the main channel subwatershed drainage density.

Drainage Density displays the drainage density value for the main valley bottom channel subwatershed as determined from the main channel Valley Length (ft.) and the GeoFluv Boundary Area (ac.). The drainage density is displayed in units of feet/acre in U.S. units, a convenient unit for landform design work.

If the drainage density is within the variance that the user specified in the Design Natural Regrade dockable dialog box's Settings button, Natural Regrade Global Settings, "Target drainage density variance (%)", then the value will be highlighted in green; if the value is outside the user-specified variance it will be highlighted in red. A red warning
can mean that the drainage density is too high or too low. If too high, the channel can be shortened or the GeoFluv Boundary area decreased. If the value is too low, the main channel can be lengthened or more channels can be added using the Channels tab's Add button.

### Pre-disturbed Surface

#### Function

The user defines a three-dimensional surface file that GeoFluv™ will use as the reference surface from which the fluvial geomorphic surface will be designed. This surface file could be an existing Approximate Original Contour map, a pre-disturbance map, or any other surface from which the user wants to begin the design.

When the user clicks on the Surface for Elevations button, the Use Existing TIN or Create New TIN? Pop-up dialog box appears to give the user the options, by clicking on radio buttons, for entering a 3-D surface file. The user can type the file name into the File Name field or browse for the file by left-clicking the Browse button to the right of the File Name field. Left-clicking the browse button will open another dialog box that will display file selections and the directory path. The user can search for the surface file in various directories and left-click the Open button when the desired 3-D surface file is found.

When Open is clicked in the file search dialog box, the search dialog disappears and the Carlson Software 3D Viewer window will appear showing the .tin for the area that the user has defined. The user can rotate, fill in the .tin triangles, etc. to preview the .tin to be sure that it is satisfactory, i.e., no unwanted holes, elevation spikes, etc. When the user is satisfied that the .tin correctly represents the comparison surface, the user closes the 3D viewer window and the file name is entered into the File Name field in the Select Surface for Elevations TIN File - (tin;flt) dialog box, the file name appears below the Surface for Elevations button, details of the file loading will be listed on the command line: Loadings edges . . . , the number of points and triangles that were loaded will be listed. Regrade will also conduct an automatic save of the file and the path will be stated. The user is then ready to continue to Channels tab.

Alternatively, the user can click the radio button for Create new TIN file by selecting entities in the drawing. When the user selects this option and clicks OK, the cursor changes to a selection box that the user can use to define an area with a crossing window. (Note: it is very important that this area encompass the entire GeoFluv project .tin surface. If areas outside the GeoFluv boundary area may be used for material borrow and incorporated into the cut / fill balance, the .tin area should include those areas also.) After the user defines the .tin area and hits the enter key, the Carlson Software 3D Viewer window will appear as above. The remaining steps are also as described above.

When the Surface for Elevations file has been accepted, the file name is listed below the Surface for Elevations button, and GeoFluv™ reads the head and base level elevations from the Surface for Elevations file for the main channel that the user has sketched and displays these elevations in the "Data for main channel:" fields above the Surface for Elevations button. GeoFluv™ designs the main channel from this information and the settings on the Channels tab. The elevation at the heads of all other channels have their defaults set by the Surface for Elevations. The elevations along the GeoFluv Boundary are also set from this surface. This in turn sets the elevations of the main ridges and subridges and subridge valleys that intersect the GeoFluv Boundary.

### Channels Tab

The Channels tab is used to input variables that GeoFluv™ will use to design channel geometry dimensions (including radius of curvature, meander length, meander belt width, sinuosity, and channel cross sections that are sized for bankfull and more extreme flood events), to add or delete channels from the design, to name channels, to view channel longitudinal profiles, and to design related upland landforms, and to generate reach-scale reports of the design characteristics of channels.

GeoFluv™'s draft design will have concave longitudinal channel profiles that join together in a smooth hydraulic transition. GeoFluv™ will automatically design drainage-divide ridges between the channels that form subwatersheds for each channel using this information. GeoFluv™ will also automatically design the sub-ridges and sub-
Channel Add

The Add button is used to add each channel to the watershed design.

Command Prompt:
Select tributary channel polyline. Select objects

The user selects the polyline that represents the valley bottom for a channel that is to be added to the GeoFluv™ design. The selected polyline must meet the following criteria:

- One end must be near another valley bottom polyline that has already been added to the design.
- The other end must be near the GeoFluv Boundary.
- It must not cross the GeoFluv Boundary.
- It must not cross any valley bottom polyline.
- It must not cross itself.
- It must not be closed.

When executed correctly, the command prompt reads, "Creating final design surface . . . DONE", GeoFluv™ adds the channel to the design, lists it in the Current Channel menu, retains the input settings from the previously added channel, designs the channel based on those input settings, and recalculates and displays the channel length, subwatershed area, and subwatershed drainage density. The user can view the channel's vertical curve profile and edit any of the channel design input settings. When the user left-clicks on a channel name in the Current Channel field, GeoFluv™ draws an arrow on the design pointing to that channel.

GeoFluv™ uses a consistent naming convention for channels, because this has been found to be a very important attribute for communication when taking designs to the field. Everyone involved with the project, from the designers to surveyors to equipment operators can clearly know what part of the project is being discussed when following this consistent naming convention, and this minimizes the chances of miscommunication and mistakes. GeoFluv™ uses the main valley bottom channel that drains to the watershed's local base level for the primary name, for example "Carlson Arroyo". The channels tributary to "Carlson Arroyo" have alphanumeric names that follow the hydrologic right- and left-bank convention, that is, right and left bank when facing downstream. The first tributary downstream
of the headwaters entering "Carlson Arroyo" on its right bank is labeled "Carlson R1" and the first tributary entering on the left bank is "Carlson L1". This convention is applied to the tributaries themselves, so that the first tributary entering "Carlson R1" on its left bank is labeled "Carlson R1L1", and so on. GeoFluv™ will revise the naming sequence so that when all the channels in the watershed have been added, each channel will be named correctly following this convention.

To name the channels differently, simply type the preferred name into the edit box in the Change Channel Name dialog box accessed using the Channels tab’s Name button.

**Channel Delete**

The Delete button is used to delete the "Current Channel" from the watershed design.

First, the correct channel must be chosen in the dropdown list on the Channel tab. The user can change the current channel by left-clicking on the menu arrow to the right of the Current Channel list-box and selecting the name of the channel that is to be deleted. The user then left-clicks on the Delete button.

GeoFluv™ deletes that channel name from the list, deletes that channel's input settings, deletes any tributaries that connect to this channel, adjusts the names of the remaining channels according to GeoFluv™'s naming convention, recalculates the ridges and subwatersheds and other aspects of the GeoFluv™ design, and makes the main valley bottom channel to be the "Current Channel."

**Channel Name**

The Channels tab’s Name button allows the user to change the name of a channel within the GeoFluv Boundary that has been named according to GeoFluv™'s default automatic naming convention.

Left clicking on the Name button causes the Change Channel Name dialog box to appear on the screen. The user types the new channel name into the "Channel's name:" edit box and left-clicks the OK button to apply the new name.

The user can toggle the Change Channel Name dialog box's option to "Update tributary channel names" on or off. This option will automatically rename all channel's that are tributary to the channel named in the "Channel's name:" edit box using that new name. Note that if the toggle is off, the selected channel will be renamed, but the channel tributary to it will not, but may need to be manually renamed if its name includes a GeoFluv™ alpha-numeric portion, i.e., if Moose Creek RE1 is renamed Spruce Creek, its tributary's name, Moose Creek R1R1, will still include the now meaningless R1R1.

If the user does not want to use the default GeoFluv™ channel naming convention, they can rename the channels simply by toggling off the Update tributary channels names option and typing in any name.

**Channel Transition**

This button allows the user to change the transition point from a reach greater than -0.04 slope to less than -0.04 slope in a channel's longitudinal profile.

**Command Prompt:**

Choose the forced transition point between channel types. (Press Enter to find automatically.)

When the user left-clicks on the Transition button, the cursor changes to a crosshair that the user can place on the valley line to specify a new transition point. The user can elect to allow GeoFluv™ to determine this point automatically based on the elevation data supplied in the Pre-Disturbed Surface file by pressing the Enter key.

**Current Channel**

The Current Channel list-box displays the name of the current GeoFluv™channel that the user is designing. The main valley bottom channel was specified in the Settings tab and this channel is the first listed in the Current Channel tab. Channels that are tributary to the main valley bottom channel are added in the Channels tab using the Add button. The user can see a listing of all channels that are built by left-clicking on the down arrow to the right of the list-box. Then left-clicking on a channel name will make that channel be the "current channel".

---

Chapter 12. Natural Regrade Module
Current Channel Settings

This button allows the user to specify settings that will vary the channel discharge and the related channel geometry and upland ridge and subridge morphology specific to the subwatershed active in the Channels tab current channel name box. The settings are organized on two tabs, Geometry and Watershed. The Geometry tab has settings for maximum velocity, upstream slope, downstream slope, width to depth ratio, sinuosity, random scale factors on sinusoidal channel, subridge spacing on sinusoidal channel, and channel head and mouth elevation. The Watershed tab has settings for runoff coefficient when using the Rational Runoff Method (the default method), or to allow input of discharge computed by an alternate method, and to add runoff from contiguous land areas.

Left-clicking on the "Settings" button brings up the "Channel 'xxxx' Settings" dialog box that gives the user the options shown below. The optional settings made in the "Channel 'xxxx' Settings" dialog box will apply only to the Channel 'xxxx' subwatershed. The blue subject bar at the top of the dialog box displays the name of the channel's subwatershed to which the Settings will apply. The user will select a different channel in the "Current Channel" window of the "Channels" tab and then left-click on "Settings" to make these changes to other channels and their subwatersheds, e.g., 'Channel yyyy', 'Channel zzzz,' etc. After specifying the settings in the dialog box, the user can apply them by left-clicking the "OK" button at the bottom of the dialog box.

Geometry Tab

Maximum Water Velocity (ft./s.): The user can specify a maximum water velocity for the channel by typing the desired value into the edit box. Velocity is inversely related to channel cross-sectional area for a given discharge according to the relationship Q/a=v, where Q is discharge (cubic feet per second), a is area (square feet), and v is velocity (feet per second).

Upstream slope %: The user can specify the upstream slope for the channel using this edit box. This feature can be used to vary the channel's longitudinal profile that will join to a mouth slope dictated by the receiving channel slope at their confluence. It can also be used to tie into the upstream slope when the headwaters of the channel are at the GeoFluv Boundary and join with an upstream channel slope draining "Additional watershed area."

Downstream slope % (Only adjustable on main channel.): The user can specify the mouth slope for the main channel at the GeoFluv Boundary to join smoothly to the downstream channel slope by typing the desired slope into the edit box. If the Channel's tab Settings dialog box is open for any tributary to the main channel, the edit box will read "n/a."

Width-to-Depth, slope >-0.04: xx.xx, < -0.04: xx.xx: The user can specify width-to-depth ratios for channels with
slopes greater and less than -0.04 by typing the desired width-to-depth ratio into the edit box. The default values are 10.00:1 for channels with greater than -0.04 slope and 12.5:1 for channels with less than -0.04 slope.

**Sinuosity, slope > -0.04: xx.xx, < -0.04: xx.xx:** The user can specify sinuosity for channels with slopes greater and less than -0.04 by typing the desired sinuosity into the edit box. The default values are 1.15 for channels with greater than -0.04 slope and 1.48 for channels with less than -0.04 slope.

**Random scale factors on sinusoidal channel:** The meander pattern of the idealized draft valley bottom channels (< -0.04) will be determined by mathematical constants and thus will be very uniform, changing (enlarging) as a function of flow (related to discharge) and valley bottom orientation. Checking the 'Random scale factors on sinusoidal channel' box will randomly vary the constant values, within their acceptable ranges for stable channels, such that radius of curvature, meander length, and meander belt width vary. This random variation produces a more natural appearance for the channel and related upland landforms.

**Subridge spacing on sinusoidal channel:** This setting applies to channels with slopes < -0.04. The lower-gradient channels, with slopes < -0.04, may have an adjacent floodplain (or terrace) area and the uplands landform may begin some distance from the channel banks. The user can use this setting to create some of this open floodplain or terrace area by increasing the spacing between subridges. A subridge spacing setting of 3, for example, will create a subridge on every third meander bend of the channel with an opening for the floor of the subridge valley between these subridges.

Note: The user must select odd-number spacing; specifying even number spacing will result in all subridges and subridge valleys being on opposite sides of the valley. Even spacing can be made with manual Carlson editing. The user can also manually add or delete subridges, or vary subridge longitudinal profiles using Natural Regrade's longitudinal profile editors, to introduce more variation to the draft GeoFluv™ landform.

**Specify head elevation:** The user can specify the head elevation for any channel, rather than accepting an elevation that is automatically determined from the Pre-disturbance file specified in the Settings tab. The user checks the box to select this option and then proceeds in one of two ways. The user can type a desired headwater elevation into the Specify Head Elevation field. Alternately, the user can left-click on the Pick button and then identify a (COGO) point of the desired elevation on the drawing. To use the Pick method, the user left-clicks the cursor near the desired point and then, by moving the cursor diagonally, creates a box around the point. The user left-clicks again to define the opposite corner of the box surrounding the desired point and the point elevation is entered into the Specify Head Elevation field.

**Specify mouth elevation:** The user can (and should) specify the mouth elevation for the main channel only. This setting becomes inactive on the tributary channels because their mouth elevation is controlled by the main channel's longitudinal profile. The procedures for setting the elevation are the same as in Specify Head Elevation above.

Note: The user should specify the mouth elevation of the main channel in the GeoFluv™ project area because this elevation and the channel slope immediately downstream of this point may be the most critical variables for assuring a stable landform design. The elevations that Natural Regrade interpolates from the 'Pre-disturbed surface' specified in the Settings tab are appropriate for creating and comparing draft design alternatives, but a channel mouth elevation interpolated from a map surface can vary from the actual elevation on the order of feet. A channel will be expected to adjust to elevation and slope inaccuracies by erosion.

**Watershed Tab**
Use Rational Runoff Method: This is the default setting for calculating runoff to the GeoFluvtm channels in Natural Regrade and is the setting that will be used when the box is checked. The Rational Runoff Method calculates a peak discharge using the formula \( Q_{pk} = CIA \), where \( C \) is the runoff coefficient, \( I \) is the rainfall intensity, and \( A \) is the acreage. The user enters the appropriate runoff coefficient for the area within the GeoFluvtm boundary in the Runoff Coefficient field and Natural Regrade does all the related calculations.

Use manual Qpk: The user can choose to input a peak discharge value calculated by some other method by checking the 'Use Manual Qpk' option. When the user checks this box, the runoff coefficient field in the Use Rational Runoff Method setting (and use of that method) becomes disabled. The user then types in the peak discharges to use for the two storm events.

Note: The GeoFluv™ approach uses the 2-yr, 1-hour storm event to calculate bankfull discharge and the 50-yr, 6-hr event to calculate a flood-prone discharge. Reclamation landforms constructed using the GeoFluv™ approach that use these inputs have been stable in a very harsh and erosive high-altitude desert environment through extreme storm events. Using other input values may give unsatisfactory results.

Additional Watershed Area: This setting allows the user to incorporate runoff from contiguous lands into the GeoFluv Boundary. When the user checks the Additional Watershed Area box, the fields below become active and offer a choice of how the additional runoff will enter the GeoFluv Boundary. If the head of the GeoFluv™ channel is downstream of the Additional Watershed Area, as when joining to an upstream channel reach, the user should select the "At head of channel" option. The GeoFluv™ channel's headwater dimensions will then be sized to accommodate the runoff from the area above the channel headwaters within the GeoFluv Boundary and the Additional Watershed Area upstream of that. If the Additional Watershed Area is subparallel to the GeoFluv™ channel, checking "Evenly along length" will introduce the runoff from the Additional Watershed Area gradually along the GeoFluv™ channel reach and the channel dimensions will increase proportionately along the reach. The remainder of the settings are as described above in "Use Rational Method" and "Use manual Qpk."

Data for Current Channel
These are the data that GeoFluv™ uses to calculate the drainage density for the subwatershed containing the channel in the Current Channel field above, and a display window that informs the user if discharge from additional area outside the GeoFluv Boundary is entering the subwatershed. These are not input fields, but real-time displays of the values being used in the GeoFluv™ design for the Current Channel. GeoFluv™ calculates these values from the subwatershed boundary it has built and the drainage pattern that the user sketched, and user-input additional area by the Channels tab's "Advanced . . ." button.
**Valley Length (ft.)** This value is the straight-line length of the valley (in feet in U.S. units), not the sinuous length of the channel.

**Reach Area (ac.)** This value is the area (in acres in U.S. units) draining water to that channel or channel reach.

**Add'l Area (ac.)** This field displays any additional area outside the GeoFluv™ boundary that is draining into the GeoFluv™ Current Channel. This could be contiguous undisturbed land or land that has already been reclaimed. The Channels tab's "Advanced . . ." button allows the user to add additional area.

**Drainage Density (ft/ac)** This value is the ratio of Valley Length to Reach Area in U.S. units of feet per acre, a convenient unit for this parameter in landform design work.

If the drainage density is within the variance that the user specified in the Design Natural Regrade dockable dialog box's Settings button, Natural Regrade Global Settings, "Target drainage density variance (%)", then the value will be highlighted in green; if the value is outside the user-specified variance it will be highlighted in red. A red warning can mean that the drainage density is too high or too low. If too high, the channel can be shortened or the Current Channel's subwatershed area increased. If the value is too low, the Current Channel can be lengthened, or a tributary channel can be drawn in the Current Channel subwatershed and then added using the Channels tab's Add button, or the subwatershed area can be decreased.

If the GeoFluv Boundary polyline or the valley bottom polylines are modified in the drawing, clicking on the Reread Valley Bottoms button will cause the above data to be updated.

**Profile**

This button activates a popup view window, Profile Viewer, which allows the user to see the Current Channel's longitudinal profile graphically. Moving the viewer cursor along the profile allows the user to obtain the station, elevation, and slope at any point indicated by crosshairs along the profile.

![Profile Viewer](image)

**Vertical Exaggeration** This toggle button setting allows the user to select profile views at fit, 1x, 2x, 5x, and 10x vertical exaggeration.

**Drag Action** This toggle button setting allows the user to select either zoom or pan drag action. Then the user selects the Zoom button, holding down the left-click button on the mouse as the mouse is moved will zoom in and out on the profile display. Similarly, when the user selects the Pan button, holding down the left-click button on the mouse allows the user to pan the profile in the display. Whether in Zoom mode or Pan mode, the middle mouse button can be held down to pan the profile in the display. Thus, if the user has a middle mouse button, staying in the Zoom mode and using the middle mouse button to pan is most efficient.
Grid Ticks Only This toggle button setting allows the user to select either the default x and y grid lines across the profile, or tick marks only on the axes.

Report

The Report button is used for detailed inspection of the GeoFluv™ Current Channel's design characteristics.

The report is for the channel as it would be incorporated into the design after using the Draw Design Surface button on the Output tab. Note that the channels with slopes > -0.04 do not have the meandering channel geometry relationships that lower slope channels do. Their different characteristics are designed differently in the GeoFluv™ approach and because of this radius of curvature, meander length, meander belt width, and meander width ratio are not listed.

The user left-clicks on the Report button and the "Channel 'xxxx' Report Options" dialog box opens. The user can type in the desired station interval for the report in the "Station Interval:" window. The user then left-clicks on the OK button and the report for that channel is generated according to the user-specified stationing.

| Cross-section reports are done every 50.00(ft.). |
| Stations are measured along the centerline, starting from the headwaters. |
| Stations are only reported when there is a real cross-section formed by the four polylines of the built channel. |
| The length of the centerline is 908.85(ft.). |
| Left and right are from the point of view of looking downstream. |

| station (ft.): | 0.00 |
| slope at station: | -0.12 |
| flood prone width (ft.): | 0.39 |
| flood prone depth (ft.): | 0.04 |
| flood prone area (sq.ft.): | 0.01 |
| bankfull width (ft.): | 0.17 |
| bankfull depth (ft.): | 0.02 |
| bankfull area (sq.ft.): | 0.00 |
| bottom width (ft.): | 0.03 |
| Shields shear stress, bankfull width (lbs/sq.ft.): | 0.07 |
| Shields shear stress, flood prone width (lbs/sq.ft.): | 0.17 |
| right side slope (%): | 25.00 |
| left side slope (%): | 25.00 |

The report gives summary design information for the Current Channel and lists channel-reach detailed information at the user-specified station intervals. The stationing increases in the downstream direction with station 00 being the channel head.
Output Tab

Function

The Output Tab allows the user to preview the channels and ridgelines that will be contoured to reveal the draft GeoFlu™ design landform, to draw and contour the surface, to save the design, to verify the average drainage density within the GeoFlu Boundary, to compare the cut and fill volumes needed to create the design and to verify that the cut and fill volumes balance within a user-specified limit, and to create and view a summary report of the channel settings and design dimensions.

Preview

The Preview button displays the channel and main ridgelines from which GeoFlu™ will base its draft landform design.
**Command Prompt:**
The command reads, "Preview. Use View menu commands to change views. Press Enter to continue." when the Preview button is left-clicked.

Left-clicking on the Preview button draws the main GeoFluv™ channel and ridge design lines on the drawing. The A and A+ channel reaches (> -0.04 slope) are displayed as zig-zag lines. The valley bottom channel reaches (< -0.04 slope) are displayed as sinuous curved lines. The main ridgelines are shown between the tributary channels and are sub-parallel to the channels.

**Data for GeoFluv Work Area**
These are the data that GeoFluv™ uses to calculate the drainage density for the entire area within the GeoFluv Boundary. These are not input fields, but real-time displays of the values being used in the GeoFluv™ design for overall project area within the GeoFluv Boundary. GeoFluv™ calculates these values from the GeoFluv Boundary that the user has drawn and the drainage pattern that the user sketched.

**Valleys (ft.)** This value is the combined straight-line length of all the valleys (in feet in U.S. units), not the sinuous length of the channel, that the user has sketched within the GeoFluv Boundary.

**Area (ac.)** This value is the area (in acres in U.S. units) within the GeoFluv Boundary.

**Drainage Density (ft/ac)** This value is the ratio of Valley Length to Reach Area in U.S. units of feet per acre, a convenient unit for this parameter in landform design work.

If the drainage density is within the variance that the user specified in the Design Natural Regrade dockable dialog box's Settings button, Natural Regrade Global Settings, "Target drainage density variance (%)", then the value will be highlighted in green; if the value is outside the user-specified variance it will be highlighted in red. A red warning can mean that the drainage density is too high or too low. If too high, channels can be deleted or shortened, or the area within the GeoFluv Boundary can be increased. If the value is too low, valleys can lengthened, or a tributary channel can be drawn within the GeoFluv Boundary and then added using the Channels tab's Add button, or the area within the GeoFluv Boundary can be decreased.
Draw Design Surface integrates all of the GeoFluv™ landform design data that the user has input and outputs it to the drawing.

Left-clicking on the Draw Design Surface button causes the Draw Design Surface dialog box to appear. This dialog box allows the user to choose the layer name to which *Natural Regrade* will save the channel and ridge polylines, the triangle skirt layer, and the Sub-Watersheds. Toggles in the dialog box also allow the user to specify:

- If the triangle mesh outside the GeoFluv™ boundary will be drawn.
- If the 2D outlines of subwatersheds will be drawn.
- If intersecting built tributary channels are trimmed at the point of intersection or if they continue all the way to the confluence.
- If existing entities in these layers are erased.

Clicking the OK button in the Draw Design Surface dialog box will capture these settings for the GeoFluv™ design. If the settings are valid, *Natural Regrade* will insert the subwatershed subridge and subvalley breaklines into the drawing, regardless of how many are needed to create the stable draft design and the Triangulate and Contour from TIN dialog box will pop up. The user can edit the settings on the dialog box tabs or accept the default settings. The
user clicks OK to begin contouring.

Natural Regrade will draw the draft GeoFluv™ landform contours on the drawing and a pop-up Carlson Edit dialog box will appear that lists any instances of 'crossing barrier lines', if the triangulate and contour settings were appropriate. The user can use this edit box to review the drawing for possible errors; typically the crossing barrier lines reported in this edit box are intersections of channel and valley lines. (See also the Draw GeoFluv Contours command for more detail about this feature.)

If the 'maximum triangle mesh line length' setting in the Triangulate tab of the Contour selection in the Carlson DTM Triangulate and Contour menu is set to a value less than the required triangle mesh line length for portions of the design, the command line will read 'Ignored 'xxx' triangulation lines that exceeded maximum tmesh line length' and only those portions of the design, if any, that did not exceed the maximum tmesh line length will be contoured. If this occurs, the user can reset the maximum triangle mesh setting in the DTM menu to be greater than the 'xxx' distance reported in the command line and then repeat the Draw Design Surface command sequence as described above. GeoFluv™ will then contour the entire drawing as described above. (See also the Draw GeoFluv Contours command for more detail about this feature.)

The subridgelines and the valleys between them extend from the main ridgelines to the channels. The slopes have default settings that create concave slopes, rather than constant gradient or convex slopes that are subject to rill and gully formation.

Save Design Surface

The Save Design Surface button provides a quick means to save the triangulation mesh file of the GeoFluv™ draft design surface. The draft design surface is virtual and is not necessarily represented in the drawing at the moment. The draft design surface is created using the inputs of the 2D valley bottom polylines, the GeoFluv Boundary, the Pre-Disturbed Surface, and the various settings of the current GeoFluv project. The draft design surface is the same one that would be created by the Draw Design Surface button.

Any modifications to ridge or subridge or channel polylines in the drawing using tools such as Edit Longitudinal Profile are not a part of the draft design surface. To create a triangulation mesh file of the design surface in the drawing, use the Draw GeoFluv Contours command in the Natural Regrade dropdown menu and select the Write Triangulation File option on the Triangulate tab.
The user left-clicks on the Save Design Surface button and the Save Design Surface - (.FLT; .TIN) dialog box appears on the screen. The user is offered three options to name and save the surface file. The user can type in the name of a new or existing file in the File Name window, or left-click on the Browse button to the right of the window to get a list of surface files related to the project. If the user wants to save surface file as an existing file (overwrite the file), they can highlight the file name in the Recently Used Files: window at the bottom of the dialog box or in the "Files in that folder" window at the right of the dialog box. The user then left-clicks on the Open button at the bottom of the dialog box to save the file with the selected name.

**Update Cut/Fill**

The Comparison Surface button is used to enter a three-dimensional surface file (.flt or .tin) for determination of cut and fill volume differences between the comparison surface and the GeoFluv landform design that the user has made.

When the user clicks on the Comparison Surface button, the Use Existing TIN or Create New TIN? Pop-up dialog box appears to give the user the options, by clicking on radio buttons, for entering a 3-D surface file. By clicking OK when the radio button is on Search for existing TIN file, the user can browse through existing files to select the file to import, or select the file from a list of recently used files. When the user highlights the desired file and clicks the Open button, the file name appears below the Comparison Surface button and the user is ready to begin the Update Cut / Fill command.

Alternatively, the user can click the radio button for Create new TIN file by selecting entities in the drawing. When the user selects this option and clicks OK, the cursor changes to a selection box that the user can use to define an area with a crossing window. (Note: it is very important that this area encompass the entire GeoFluv project .tin surface. Areas outside the work area that are the same in both the comparison surface and the GeoFluv design will not affect the volume balance so the user does not have to be concerned with defining a slightly larger area.) After defining the new .tin area, the user hits the Enter key and the Select Comparison Surface TIN file - (.tin; .flt) dialog box appears.

The user can choose an existing .tin file by browsing folders or choosing from recently used files, or click on the New tab to create the new .tin file. The user can click on the New tab, enter a name for the new .tin file, and click OK.

The Carlson Software 3D Viewer window will appear showing the .tin for the area that the user has defined. The user can rotate, fill in the .tin triangles, etc. to preview the .tin to be sure that it is satisfactory, i.e., no unwanted holes, elevation spikes, etc. When the user is satisfied that the .tin correctly represents the comparison surface, the user closes the 3D viewer window and the command prompt line reads Select Inclusion Polylines.

The Select Inclusion Polylines option allows the user to define area boundaries for use in the Cut / Fill balance with polylines. By default Natural Regrade will use the GeoFluv boundary polyline as an inclusion boundary to compare against the specified Comparison Surface. Inclusion area boundaries are useful if the user wants to add an adjacent stockpile volume to the calculations, for example. The user clicks on any additional desired inclusion area polylines, including the GeoFluv boundary polyline as needed, that Natural Regrade will use in the calculation. If no inclusion boundary lines other than the GeoFluv boundary are needed, or when all selections are made, the user can hit Enter and is prompted to select Exclusion polylines.
Exclusion polylines are the inverse of inclusion polylines. They can be used to exclude an area like a homesite that is surrounded by the GeoFluv project. If no exclusion boundary lines are needed, or when all selections are made, the user can hit Enter and is prompted to select Exclusion polylines. Natural Regrade will then display the number of inclusion and exclusion polylines that will be used in the cut / fill calculation. The user is then ready to proceed to the Update Cut / Fill button to make the calculation.

In the example, the user has selected two inclusion boundaries, the GeoFluv boundary and a boundary line around a stockpile southwest of the GeoFluv boundary, and one exclusion boundary on top of a ridge near the middle of the GeoFluv design.

The Update Cut / Fill button makes the calculation of the cut and fill needed to make the GeoFluv design from the comparison surface that the user has specified.

When the user clicks on the Update Cut / Fill button, the Carlson Software 3D Viewer window appears showing the .tin that will result from the user's specified file and any inclusion and exclusion boundaries. This helps the user to quickly verify that the specified areas are as desired. The user may also find it helpful to use the 3D Viewer's Toggle shading of surfaces button to fill in the triangle mesh spaces when inspecting the .tin.
When the user closes the 3D viewer, the calculation results are displayed below the Update Cut / Fill button.

The calculation respects any inclusion and exclusion areas that the user has specified. When the result is within the balance range that the user specified in the Natural Regrade Global Settings (accessed via the Settings button), the Cut / Fill (%) is highlighted in green to give the user quick feedback; conversely, if the result is outside the user-specified range the result is highlighted in red.

**Summary Report**

The Summary Report button provides the user with a quick summary report of the input parameters and resulting dimensions and material volumes that *Natural Regrade* used to design each GeoFluv™ channel within the project's GeoFluv Boundary.

![Natural Regrade Summary Report dialog box](image)

The user left-clicks on the Summary Report button and the GeoFluv Summary Report dialog box appears on the screen. The dialog box gives the user the options of creating a custom report by checking the "Use report formatter" box (toggle on) and presenting characteristics of Rosgen channel types by checking the "Show Rosgen example channels" box (toggle on; this is the default setting).
This information can be useful to compare the channels' morphology with other natural channel types when editing the draft GeoFluv™ design to verify that changes to the channel do not exceed the range established for that stable channel type. The summary report information can also be useful for estimating if the user may want to increase channel roughness, install additional bank protection or channel weirs to augment step-pool sequences, etc. Fields that contain information that is not used in the GeoFluv™ approach for designing A and Aa+ channels (>0.04 slope) are marked n/a. Many of the channel characteristics occur within a range at any particular reach in stable natural channels, rather than as a specific value. The dimensions also change in the up-and-downstream directions as a function of discharge. The Summary Report presents the range of these values that are applicable to the entire length of each channel. The user can report channel reach-specific information by using the Channels tab's Report button.

**DWG Tab**

**Draw GeoFluv Contours**

This command gives the user single-click access to the "Triangulate and Contour from TIN" dialog box via the *Natural Regrade* drop-down menu.

After the user has used the Design GeoFluv Regrade dockable dialog box/Output tab's Draw Design Surface button to create the GeoFluv™ design in the drawing, the user can left-click on the Draw GeoFluv Contours command and produce the Triangulate and Contour from TIN dialog box to contour revisions to the polylines in the layers that the GeoFluv™ design was drawn to.
When the contours have been drawn, the **Error Log:** C:\Scad2005\User—Trierror.xml dialog box will appear. The user can review this error log, or close the box and proceed with the contouring if precise detail is not yet required at this design stage. This Error Log reports any potential errors that Carlson has detected when contouring the drawing.

For example, if the report has a Crossing Breaklines (two polylines with different elevations) field, the user can left-click on that field and a list of the detected crossing breaklines will appear. The user can then left-click on each detected crossing breakline and its x and y coordinates will be displayed at the bottom of the dialog box. The user may choose to report or draw all the detected potential problems using the **Report All** and **Draw All** buttons, or may highlight to select a single potential problem. If the user selects a single problem, the buttons change to **Report**...
One and Draw One.

The user can left-click on the **Zoom** button to inspect the suspected problem; this will zoom to the relevant area of the drawing and place an arrow that points to the suspected problem on the drawing. Left clicking on the **Zoom In** button will allow closer inspection of the area of concern, and the **Zoom Out** button will return the user to the previous view.

For example, if only one entity was selected as a problem of concern, the "Report . . " button will indicate Report One and left-clicking on the **Report One** button brings up the Carlson Edit: c:\scad2005\USER\scadrprt.tmp dialong box that displays a Crossing Breaklines Report with the x and y coordinates of the problem, and the elevation difference between the crossing breaklines. Left clicking on the **Draw One** button draws the selected potential problem breakline on the drawing and brings up an AutoCAD dialog box that tells the user that one feature has been processed.

When the user closes the Error Log dialog box by left-clicking on the X in the upper right corner or on the **Done** button, the Error Log dialog box disappears and the contoured GeoFluv™ design remains on the screen. The user can then choose to edit the drawing using tools in the **Natural Regrade** menu, or any other Carlson menu tools, or can reopen the Design GeoFluv Regrade dockable dialog box to edit any of the GeoFluv™ settings there.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfContour  
**Prerequisite:** Design geofluv

### 3D GeoFluv Contour Viewer

This Natural Regrade menu gives the user single-click access to the **3D GeoFluv Contour Viewer** that displays, in 3D, the surface created from the contours of a GeoFluv™ design. Viewing the contours is more representative of how the landform will look after grading than the surface produced by the **3D GeoFluv Surface Viewer**. The **3D GeoFluv Surface Viewer** shows you the surface based on the GeoFluv™ design, before using Triangulate and Contour. This resulting surface tends to be angular and faceted, and it is also the surface used for volume calculations. The **3D GeoFluv Contour Viewer** shows you the surface based on the GeoFluv™ design after using Triangulate and Contour, and therefore has more and smaller triangles, lending a smoother appearance to the 3D image.

Note that these commands use linework from particular layers in the drawing. This means that any editing the user makes to the linework in these layers will be reflected in the resulting 3D image.

The prerequisite to using the 3D GeoFluv Contour Viewer is that the contours must already exist. To create contours, the user can select the Triangulate and Contour option after clicking on the Draw Design Surface button on the Output tab of the Design GeoFluv Regrade command. Alternatively, the user can use the Draw GeoFluv Contours command on the Natural Regrade drop-down menu, which will create the contours based on the GeoFluv™ design that exists in particular layers in the drawing.

Clicking on the 3D GeoFluv Contour Viewer command first shows a dialog box asking the user to verify the layers in the drawing that the contours are in. There is also an option for saving the surface created from the contours into a TIN file, which can then be used with other tools in other Carlson Civil / Survey modules. Clicking on the OK button causes the contours in the selected layers to be "triangulated" into a solid surface, or TIN, and then opens the Carlson Software 3D Viewer with the GeoFluv™ design surface displayed.
The user has many options for viewing the image available in the View Control tab dialog box on the right side of the 3D Viewer screen. The 3D project view can be rotated on the x, y, and z axes using the sliding Rotation Axis controls to the right of the view. By left-clicking and dragging the slider control below the image, the user can clip off forward portions of the view. The viewer has the ability to add vertical exaggeration to aid inspection of lower-relief areas by left-clicking on the arrow to the right of the "Vert. scale" edit box and selecting a factor from the dropdown menu. The viewer can also change the position of the sun on the project to evaluate sunny and shady areas throughout the day, a very useful tool for identifying optimal areas for different plantings. The user can either left-click on the 'sun' (yellow box in the blue circle) and drag across the 'sky' from the west (the blue circle is the sky) or move the slider buttons surrounding the blue circle. The 3D viewer has the ability to color the view by elevation layers by a toggle setting at the top of the dialog box. These views are helpful for construction to help workers visualize how the final project surface can be built in a series of lifts, for example by using GPS-guided truck dumping.

The toggle buttons on the dialog box below the blue and yellow 'sun and sky' indicator control:

**Pan** The user holds down the left-click button and moves the mouse across the drawing to pan the drawing in the 3D Viewer.

**Rotation** The 3D project view can be rotated on the x, y, and z axes by left-clicking the rotation toggle button and then holding down the left-click button while moving the mouse on the drawing.

**Dynamic Zoom** The user can zoom in and out of the 3D view by holding down the left-click button and moving the mouse up and down on the drawing.

**Shading** The user can toggle to fill with shading (color) between the TIN file's triangular edges to give the drawing a solid surface appearance.

**Average Elevation** The user can toggle to have an arrow appear on the drawing surface that indicates the average elevation at the point at which the arrow points.

**Reset to Plan** The user can left-click on this button to cancel all rotation settings and return to plan view.

The Carlson Software 3D Viewer's Advanced tab has options to block model objects, shade the view, export the view image, and save the view that are fully described in the General Commands/View Commands documentation.

The user can exit the 3D Viewer by left-clicking on the X at the upper right or the door at the bottom of the dialog box.

**Pulldown Menu Location:** Natural Regrade

**Keyboard Command:** gfViewC
Prerequisite: Design geofluv

3D GeoFluv Surface Viewer
This *Natural Regrade* command gives the user single-click access to a 3D GeoFluv™ surface viewer that is based on the GeoFluv™ design. The 3D GeoFluv Surface Viewer displays, in 3D, the surface created from the linework that was drawn by the Design GeoFluv Regrade command. This resulting surface is the same one that is used for volume calculations. Alternatively, the 3D GeoFluv Contour Viewer displays, in 3D, the surface created from the contours of a GeoFluv™ design which has more and smaller triangles lending a smoother appearance to the 3D image.

Note that these commands use linework from particular layers in the drawing. This means that any editing the user makes to the linework in these layers will be reflected in the resulting 3D image.

The prerequisite to using the 3D GeoFluv Surface Viewer is that the linework for a GeoFluv™ design must already exist in the drawing. To create the GeoFluv™ design in the drawing, the user can click on the Draw Design Surface button on the Output tab of the Design GeoFluv Regrade command.

Clicking on the 3D GeoFluv Surface Viewer command causes the 3D Surface Viewer dialog box to appear on the screen.

The user has many options for viewing the image available in the View Control tab dialog box on the right side of the 3D Viewer screen. The 3D project view can be rotated on the x, y, and z axes using the sliding Rotation Axis controls to the right of the view. By left-clicking and dragging the slider control below the image, the user can clip off forward portions of the view. The viewer has the ability to add vertical exaggeration to aid inspection of lower-relief areas by left-clicking on the arrow to the right of the "Vert. scale" edit box and selecting a factor from the dropdown menu. The viewer can also change the position of the sun on the project to evaluate sunny and shady areas throughout the day, a very useful tool for identifying optimal areas for different plantings. The user can either left-click on the 'sun' *(yellow box in the blue circle)* and drag it across the 'sky' from the west (the blue circle is the sky) or move the slider buttons surrounding the blue circle. The 3D viewer has the ability to color the view by elevation layers by a toggle setting at the top of the dialog box. These views are helpful for construction to help workers visualize how the final project surface can be built in a series of lifts, for example by using GPS-guided truck dumping.

The toggle buttons on the dialog box below the blue and yellow 'sun and sky' indicator control:
**Pan** The user holds down the left-click button and moves the mouse across the drawing to pan the drawing in the 3D Viewer.

**Rotation** The 3D project view can be rotated on the x, y, and z axes by left-clicking the rotation toggle button and then holding down the left-click button while moving the mouse on the drawing.

**Dynamic Zoom** The user can zoom in and out of the 3D view by holding down the left-click button and moving the mouse up and down on the drawing.

**Shading** The user can toggle to fill with shading (color) between the TIN file's triangular edges to give the drawing a solid surface appearance.

**Average Elevation** The user can toggle to have an arrow appear on the drawing surface that indicates the average elevation at the point at which the arrow points.

**Reset to Plan** The user can left-click on this button to cancel all rotation settings and return to plan view.

The Carlson Software 3D Viewer's Advanced tab has options to block model objects, shade the view, export the view image, and save the view that are fully described in the General Commands/View Commands documentation.

The user can exit the 3D Viewer by left-clicking on the X at the upper right or the door at the bottom of the dialog box.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfView3D  
**Prerequisite:** Design geofluv

---

**Calculate GeoFluv Volume**

This *Natural Regrade* drop-down menu command is used to calculate the cut and fill volume difference between the GeoFluv™ design surface in the drawing and another surface, the Comparison Surface. The Comparison Surface is specified on the Output tab. Possible sources for the Comparison Surface may be pre-disturbed, such as the natural landsurface or an earlier reclamation design, or may be disturbed, such as a mine pit or construction site.

If the valley bottom or GeoFluv Boundary polylines have been moved, or any setting in the GeoFluv project has been changed that can affect volumes, then the design surface in the drawing will be out-of-date. The "Draw Design Surface" button must be used to create a new surface in the drawing to reflect the changes.

When the user clicks on the command, a dialog box appears with the cut and fill required to transform the first surface into the current design surface (layers GF Channels and GF Ridges). The first surface is the Comparison Surface. The cut and fill are calculated wherever the two surfaces overlap unless an inclusion polyline is given in which case the cut and fill are calculated within the inclusion polyline.

The results are displayed in cubic yards in the English system of units and cubic meters in the metric system.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfVolume  
**Prerequisite:** Design geofluv

---

**Cut/Fill Centroids**

This *Natural Regrade* dropdown menu command is designed to show the amounts and locations of cut and fill that are required to transform the Comparison Surface (typically the disturbed surface) into the design surface. The Comparison Surface is specified in the current GeoFluv™ project on the Output tab. The design surface for this command is the result of combining the GeoFluv™ design in the layers in the drawing within the GeoFluv Boundary plus the Surface for Elevations (specified on the Setup tab) outside the GeoFluv Boundary.
After comparing these two surfaces, this command identifies the centers of earth-material volumes that need to be moved and the centers of voids that need to be filled to create the GeoFluv™ design. The command includes the option to identify optimal straight-line material movement paths.

Note that this command uses linework from particular layers in the drawing. This means that any editing the user makes to the linework in these layers will be reflected in the results.

The prerequisites for using the Cut Fill Centroids command is that the linework for a GeoFluv™ design must already exist in the drawing and the Comparison Surface must be set. To create the GeoFluv™ design in the drawing, the user can click on the Draw Design Surface button on the Output tab of the Design GeoFluv Regrade command. The Comparison Surface file can be entered by clicking on the Comparison Surface button on the Design GeoFluv Regrade Output tab.

Clicking on the Cut Fill Centroids command causes the Cut & Fill Centroid Locator dialog box to appear, if the prerequisites have been met. The Cut & Fill Centroid Locator dialog box gives the user several options.

**Minimum Region Volume** allows the user to type a minimum cut / fill centroid region volume for the calculations into an edit box.

**Generate Labels** is a toggle setting that allows the user to have the centroid region number, cut or fill, and volume value labeled on the drawing next to a crosshair that indicates the centroid coordinates.

**Text Size Scaler:** Allows the user to type a scale factor into an edit box to enlarge or reduce the size of label text. This command is inactive when Generate Labels is toggled off.

**Layer:** Allows the user to specify the layer on which the labels will be drawn by either typing them into an edit box or by left-clicking on the Select button which produces a dropdown list of existing layers from which to choose. The user can highlight a layer name on the list and click OK at the bottom of the dropdown menu to select a layer.

**Generate Boundaries** is a toggle setting that allows the user to specify if Natural Regrade shall create cut / fill boundaries and, if so, to what layer the boundaries should be saved. If toggled off, the edit window is inactive. When toggled on, the user may accept the default boundary layer name, type a different boundary layer name into the edit box, or left-click on the Select button to choose from the list of layers.

**Hatch Regions** is a toggle setting that allows the user to have the centroid regions covered with hatching to make it easier to discriminate from other parts of the drawing.
**Hatch Scale:** Allows the user to type a scale factor into an edit box to enlarge or reduce the size of hatching. If the user specifies a scaler that causes the hatch spacing to be too dense or the dash size too small, this error will be reported on the Command Line. [Tip: Before drawing a different scale, erase the previous iteration using Edit/Erase/Erase by layer.] This command is inactive when Hatch Regions is toggled off.

**Layer:** Allows the user to specify the layer on which the hatching will be drawn by either typing the layer name into an edit box or by left-clicking on the Select button which produces a dropdown list of existing layers from which to choose. The user can highlight a layer name on the list and click OK at the bottom of the dropdown menu to select a layer.

**Hatch Styles:** Allows the user to specify hatch styles to differentiate among Fill, Zero elevations between Fill and Cut, and Cut material by either typing them into an edit box or by left-clicking on the Select button which produces a dropdown list of existing layers from which to choose. The user can highlight a layer name on the list and click OK at the bottom of the dropdown menu to select a layer.

**Report Optimized Earth Movement** is a toggle setting that allows the user to specify if Natural Regrade shall not only calculate and identify the cut and fill centroids, but also determine the shortest straight-line haul distances to distribute the material from cut to fill regions.

<table>
<thead>
<tr>
<th>Cut &amp; Fill Centroid Report</th>
</tr>
</thead>
</table>

Original Ground: C:\SCAD2005\DATA\REGRADE_EXIST.FLT
Design Surface: \sea4.2.tin

<table>
<thead>
<tr>
<th>Region</th>
<th>Volume (C.Y.)</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1103732.3 Cut</td>
<td>-361.15</td>
<td>1137.23</td>
</tr>
<tr>
<td>2</td>
<td>463494.4 Fill</td>
<td>697.46</td>
<td>1407.06</td>
</tr>
<tr>
<td>3</td>
<td>150329.6 Cut</td>
<td>763.14</td>
<td>660.70</td>
</tr>
<tr>
<td>4</td>
<td>5607.5 Fill</td>
<td>750.09</td>
<td>552.55</td>
</tr>
<tr>
<td>5</td>
<td>344.3 Cut</td>
<td>257.18</td>
<td>890.03</td>
</tr>
<tr>
<td>6</td>
<td>33.5 Fill</td>
<td>375.03</td>
<td>356.83</td>
</tr>
</tbody>
</table>

Earth Movement Report:

<table>
<thead>
<tr>
<th>From Region</th>
<th>To Region</th>
<th>Volume (C.Y.)</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>312820.5</td>
<td>1092.45</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>5607.5</td>
<td>1253.67</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>33.5</td>
<td>1073.38</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>150329.6</td>
<td>749.24</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>344.3</td>
<td>679.09</td>
</tr>
</tbody>
</table>

External: 2
Total Internal Volume: 461685727.13
Total External Volume: 785270.89

When the user is satisfied with the settings on the Cut & Fill Centroid Locator dialog box, left-clicking on the OK button at the bottom will cause the centroid command selections to be executed and the Cut & Fill Centroid Report to appear on the screen. This report lists the three-dimensional surfaces that were compared to make the calculations, the material and void centroid regions that were identified, the volume of material or void in each region, whether the region identifies a cut or fill area, and the northing and easting of each centroid.
If the user toggled on Report Optimized Earth Movement, the report will be appended with the Earth Movement Report which lists the volume in cubic yards of material that has to be removed from region x to region y and the straight-line haul distance for the material movement, when such a solution can be found.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfCentroids  
**Prerequisite:** Design geofluv

### GeoFluv Channel Cross-Section Report

The *Natural Regrade* dropdown menu's GeoFluv Channel Cross-Section Report gives the user single click access to the detailed-by-station GeoFluv™ channel cross section Report that the user can create using the Channel's tab in the Design GeoFluv Regrade dockable dialog box when not actively working in the design. A user can select any GeoFluv™-designed channel in a drawing without any other files and generate this report.
Refer to the Channels tab’s Report button description for details of the report.

**Command prompt:**
Select any channel polyline created by GeoFluv. Select objects:

**Pulldown Menu Location:** Natural Regrade
**Keyboard Command:** gfReport
**Prerequisite:** Design geoFluv

**GeoFluv Channel Inspector**

This command allows the user to obtain detailed design information from the *Natural Regrade* drawing by passing the cursor over the point of interest (on a polyline in the drawing).

When the user left-clicks once on the GeoFluv Channel Inspector command in the *Natural Regrade* dropdown menu, a check mark appears to the left of the command signaling the user that the command is toggled on. Then when the user passes the cursor over any polyline in the drawing, detailed GeoFluv design information for that point on the polyline appears on the screen next to the cursor. The command remains active until the user left-clicks on the command in the dropdown menu to toggle it off.
The GeoFluv Channel Inspector works on ridge, valley, and contour polylines also, but obviously does not present channel design information for those polylines. This convenient and powerful feature allows the user to inspect designs without having to refer back and forth from a database to the drawing, but instead read directly from the drawing. Note that the information displayed is not an average for the entire line, but is specific to location on the line and can vary even in very small distances.

There are some limitations to be aware of. First, to inspect the zig-zag A-channel, the GeoFluv project that was used to create that channel must currently be open in the Design Geofluv Regrade tool. Secondly, using almost any command, including Edit Longitudinal Profile and Auto Longitudinal Profile, to modify a channel polyline causes the extended entity data to be removed which prevents the GeoFluv Channel Inspector from having certain information that it needs.

Pulldown Menu Location: Natural Regrade
Keyboard Command: gfInspect
Prerequisite: Design geofluv

View Longitudinal Profile
This Natural Regrade dropdown menu command allows the user to view the longitudinal profile of any polyline in the GeoFluv™ design and obtain the elevation and slope at any point along the profile.

Command prompt:
Select objects

The user places the cursor over the polyline that they want to inspect and left-clicks. The profile viewer appears on the screen. The user can move the cursor along the profile and the station, elevation, and slope information are displayed along the bottom of the dialog box at the position indicated by the cursor. Simultaneously, an arrow moves along the channel in the drawing pointing to the location along the longitudinal profile that the cursor is covering on the profile viewer.
Radio buttons for **Vertical Exaggeration** settings aid the user in evaluating low relief profiles.

Radio buttons also allow the user to toggle back and forth between **Zoom** and **Pan** drag action for the mouse. When set to Zoom, holding the mouse left-click button down while moving the mouse up and down will cause the viewer to zoom in and out on the longitudinal profile. When set to Pan, holding the mouse left-click button down while moving the mouse across the viewer will allow the user to pan around the longitudinal profile. Whether in Zoom mode or Pan mode, the middle mouse button can be held down to pan the profile in the display. Thus, if the user has a middle mouse button, staying in the Zoom mode and using the middle mouse button to pan is most efficient.

The **Grid Ticks Only** toggle allows the user to see a grid on the profile display or to see only tick marks on the axes.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfViewPro  
**Prerequisite:** Design geoFluv

### Edit Longitudinal Profile

The **Natural Regrade** dropdown menu's Edit Longitudinal Profile command gives the user quick access to a powerful longitudinal profile editing tool that can change the entire longitudinal profile of a 3D polyline or just a portion of the profile.

Examples of tasks that this profile editor is well suited for is creating saddles on a long ridge line to further dissect topography and creating a ‘hump’ on the ridge profile where the user might want to leave excess material.

When the user left-clicks on Edit Longitudinal Profile, the command line directs the user to Select 3D Polyline and the command prompt reads, "Select objects:" The user moves the cursor to the 3D polyline that they wish to edit and left-clicks on the polyline. The "Edit Longitudinal Profile – Double Click to Adjust Profile" pop-up dialog box appears on the screen. The dialog box has a profile viewer similar to the View Longitudinal Profile command viewer. The user can move the cursor along the profile and the **station**, **elevation**, and **slope** information are displayed along the bottom of the dialog box at the position indicated by the cursor. Simultaneously, an arrow moves along the channel in the drawing locating the point along the longitudinal profile that the cursor is covering.
The dialog box gives the user toggle settings for the following options:

**Adjust connecting linework**, when toggled on (the default setting) by left-clicking on the box, will cause *Natural Regrade* to automatically change all connecting linework, e.g., connecting ridges, to smoothly fit the new longitudinal profile. To update contours to reflect the modified surface, the Draw GeoFluv Contours command can be used.

**Grid Ticks Only** toggle allows the user to see a grid on the profile display or to see only tick marks on the axes.

Radio buttons give the user the following options:

**Vertical Exaggeration** settings aid the user in evaluating low relief profiles.

**Zoom** and **Pan** drag action for the mouse - When set to Zoom, holding the mouse left-click button down while moving it up and down will cause the viewer to zoom in and out on the longitudinal profile. When set to Pan, holding the mouse left-click button down while moving it around the viewer will allow the user to pan around the longitudinal profile. Whether in Zoom mode or Pan mode, the middle mouse button can be held down to pan the profile in the display. Thus, if the user has a middle mouse button, staying in the Zoom mode and using the middle mouse button to pan is most efficient.

A slider button on the **Blend 'x' %** control allows the user to specify the percentage of the polyline to which they want to apply the profile change. As the user holds down the mouse left-click button on the slider button and moves the slider button left to right, the percentage of the line that will be affected by the edit is displayed above the slider.

When the user has specified the settings that they want to use for the edit, they move the cursor above or below the longitudinal profile in the display to the elevation that they want to raise or lower the profile at that point and double left-click on the mouse. The profile will raise at that point to the specified elevation and the line will blend from that elevation to the remaining profile over the distance specified using the "Blend 'x' %" slider control. The user can make multiple adjustments to the longitudinal profile in this fashion until the desired profile is achieved. The user then left-clicks on the OK button to apply the changes. Left clicking on the Cancel button will close the dialog box without applying the changes.

**Command Prompt:**

Select objects:

**Pulldown Menu Location:** Natural Regrade

**Keyboard Command:** gfEditPro
Auto Longitudinal Profile

The *Natural Regrade* dropdown menu’s Auto Longitudinal Profile command gives the user quick access to a powerful longitudinal profile editing tool that can change the entire longitudinal profile of a 3D polyline or just a portion of the profile in a smooth curve by specifying starting and ending slopes.

When the user left-clicks on Auto Longitudinal Profile, the command line directs the user to Select 3D Polyline and the command prompt reads, "Select objects:". The user selects the 3D polyline that they wish to edit and left-clicks on it. The Auto Longitudinal Profile pop-up dialog box appears, which gives the user the following options.

**Top Slope** can be user-specified by typing a value into the edit box, or the default value, which is the present value for the selected 3D polyline, can be accepted. When the user exits the edit box, e.g., with Tab key, an entered slope value is applied to the profile and the user can inspect the revision on the profile viewer. The user can make multiple adjustments to the longitudinal profile in this fashion until the desired profile is achieved. This setting will be the slope at the upper end of the longitudinal profile.

**Bottom Slope** can be user-specified by typing a value into the edit box, or the default value, which is the present value for the selected 3D polyline, can be accepted. When the user exits the edit box, e.g., with Tab key, an entered slope value is applied to the profile and the user can inspect the revision on the profile viewer. The user can make multiple adjustments to the longitudinal profile in this fashion until the desired profile is achieved. This setting will be the slope at the lower end of the longitudinal profile.

**Connect to Ridge** allows the user to allow a longitudinal profile, e.g., on a ridgeline, to have an extended convex profile before beginning its concave longitudinal profile. When toggled off (the default setting with the “Convex curve length (ft.)” edit box inactivated), the GeoFluvtm approach will design a longitudinal profile between the upper and lower elevations of the 3D polyline by constructing a vertical curve using the specified bottom and top slope percents. When toggled on, the “Convex curve length (ft.)” edit box is activated and the user can type in a desired distance value that the upper end of the profile can remain convex before the GeoFluvtm vertical curve is applied using the specified Top Slope percentage. This feature can be used to place extra material in a hump, for example on a ridgeline, and still have the face of the material grade in a concave profile toward the valley bottom.

When **Adjust connecting linework** is toggled on (the default setting) by left-clicking on the box, *Natural Regrade* will automatically change all connecting linework, e.g., connecting ridges, to smoothly fit the new longitudinal profile. To update contours to reflect the modified surface, the Draw GeoFluvtm Contours command can be used.
The dialog box has a profile viewer similar to the Edit Longitudinal Profile command viewer. The user can move the cursor along the profile and the **station**, **elevation**, and **slope** information are displayed along the bottom of the dialog box at the position indicated by the cursor. Simultaneously, an arrow moves along the channel in the drawing pointing to the point along the longitudinal profile that the cursor is covering.

Radio buttons for **Vertical Exaggeration** settings aid the user in evaluating low relief profiles.

Radio buttons also allow the user to toggle back and forth between **Zoom** and **Pan** drag action for the mouse. When set to **Zoom**, holding the mouse left-click button down while moving it up and down will cause the viewer to zoom in and out on the longitudinal profile. When set to Pan, holding the mouse left-click button down while moving it around the viewer will allow the user to pan around the longitudinal profile. Whether in **Zoom** mode or **Pan** mode, the middle mouse button can be held down to pan the profile in the display. Thus, if the user has a middle mouse button, staying in the **Zoom** mode and using the middle mouse button to pan is most efficient.

**Grid Ticks Only** toggle allows the user to see a grid on the profile display or to see only tick marks on the axes.

When the user has specified the settings that they want to use for the edit, they then left-click on the **OK** button to apply the changes. The new vertical curve will be applied to the GeoFluv™ design.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** gfAutoPro  
**Prerequisite:** Design geofluv

RIVERMorph tab

The RIVERMorph tab provides for importation of stream reach design files from the 2-dimensional RIVERMorph program into **Natural Regrade** to produce a 3-dimensional design. The resulting 3-dimensional design is in a .tin format that can be directly exported to machine-control programs like Carlson Grade that guide heavy equipment operators to build the design without the need for additional field survey and staking work.

The Select RIVERMorph File button accesses the Open RIVERMorph Project - (rmp) file selection dialog box. The user can browse through RIVERMorph files to select the file to import, or select the file from a list of recently used files. When the user highlights the desired file and clicks the Open button, the file name appears below the Select RIVERMorph File button and the user is ready to begin importing the desired RIVERMorph reach.
When the user clicks on the Import Reach button, the Select River dialog box pops up; the user highlights the desired stream file and clicks OK to select the stream.

The Select Reach dialog box then pops up and the user highlights the desired reach and clicks OK. *Natural Regrade* will advise the user by a pop-up dialog if there is a mismatch in slopes or, if the slope range is valid, will display the Place RIVERMorph Reach pop-up dialog box.
The Place RIVERMorph Reach dialog box gives the user options for *Natural Regrade* to place the reach at appropriate locations based on design .tin elevations, or at user-specified points of known elevation. If the user selects a point with a slope mismatch, *Natural Regrade* will place the reach at the nearest matching point.

When the reach has been placed, it will be displayed in the reach list on the RIVERMorph tab in the Channel "(name)" Settings dialog box. The user can highlight any reach on the list and click on the View button to get a summary of the reach details. The Remove button allows the user to select a reach from the list and delete it from the current GeoFluv project. The Reposition button allows the user to revise the RIVERMorph reach location in the GeoFluv project.

When the user clicks the OK button at the bottom of the RIVERMorph tab dialog box, the RIVERMorph reach design data are imported into the GeoFluv design input data in *Natural Regrade*. The user can use the Preview button on Output tab to verify the reach location. When the user clicks the Draw Design Surface button on the Output tab, the RIVERMorph data are made into a 3-dimensional design in the GeoFluv project.

**Settings**

This button allows the user to specify settings that will vary the channel discharge and the related channel geometry and upland ridge and subridge morphology specific to the subwatershed active in the Channels tab current channel name box. The settings are organized on two tabs, Geometry and Watershed. The Geometry tab has settings for maximum velocity, upstream slope, downstream slope, width to depth ratio, sinuosity, random scale factors on sinusoidal channel, subridge spacing on sinusoidal channel, and channel head and mouth elevation. The Watershed tab has settings for runoff coefficient when using the Rational Runoff Method (the default method), or to allow input of discharge computed by an alternate method, and to add runoff from contiguous land areas.

**Command Prompt:** (blank, dialog box appears)

Left-clicking on the "Settings" button brings up the "Channel 'xxxx' Settings" dialog box that gives the user the options shown below. The optional settings made in the "Channel 'xxxx' Settings" dialog box will apply only to the Channel 'xxxx' subwatershed. The blue subject bar at the top of the dialog box displays the name of the channel's subwatershed to which the Settings will apply. The user will select a different channel in the "Current Channel" window of the "Channels" tab and then left-click on "Settings" to make these changes to other channels and their subwatersheds, e.g., 'Channel yyyy', 'Channel zzzz," etc. After specifying the settings in the dialog box, the user can apply them by left-clicking the "OK" button at the bottom of the dialog box.
Maximum Water Velocity (ft./s.): The user can specify a maximum water velocity for the channel by typing the desired value into the edit box. Velocity is inversely related to channel cross-sectional area for a given discharge according to the relationship \( Q/a=v \), where \( Q \) is discharge (cubic feet per second), \( a \) is area (square feet), and \( v \) is velocity (feet per second).

Upstream slope %: The user can specify the upstream slope for the channel using this edit box. This feature can be used to vary the channel’s longitudinal profile that will join to a mouth slope dictated by the receiving channel slope at their confluence. It can also be used to tie into the upstream slope when the headwaters of the channel are at the GeoFluv Boundary and join with an upstream channel slope draining "Additional watershed area."

Downstream slope % (Only adjustable on main channel): The user can specify the mouth slope for the main channel at the GeoFluv Boundary to join smoothly to the downstream channel slope by typing the desired slope into the edit box. If the Channel's tab Settings dialog box is open for any tributary to the main channel, the edit box will read "n/a."

Width-to-Depth, slope > -0.04: xx.xx, < -0.04: xx.xx: The user can specify width-to-depth ratios for channels with slopes greater and less than -0.04 by typing the desired width-to-depth ratio into the edit box. The default values are 10.00:1 for channels with greater than -0.04 slope and 12.5:1 for channels with less than -0.04 slope.

Sinuosity, slope > -0.04: xx.xx, < -0.04: xx.xx: The user can specify sinuosity for channels with slopes greater and less than -0.04 by typing the desired sinuosity into the edit box. The default values are 1.15 for channels with greater than -0.04 slope and 1.48 for channels with less than -0.04 slope.

Random scale factors on sinusoidal channel: The meander pattern of the idealized draft valley bottom channels (<-0.04) will be determined by mathematical constants and thus will be very uniform, changing (enlarging) as a function of flow (related to discharge) and valley bottom orientation. Checking the 'Random scale factors on sinusoidal channel' box will randomly vary the constant values, within their acceptable ranges for stable channels, such that radius of curvature, meander length, and meander belt width vary. This random variation produces a more natural appearance for the channel and related upland landforms.

Subbridge spacing on sinusoidal channel: This setting applies to channels with slopes <-0.04. The lower-gradient channels, with slopes <-0.04, may have an adjacent floodplain (or terrace) area and the uplands landform may begin some distance from the channel banks. The user can use this setting to create some of this open floodplain...
or terrace area by increasing the spacing between subridges. A subridge spacing setting of 3, for example, will create a subridge on every third meander bend of the channel with an opening for the floor of the subridge valley between these subridges.

Note: The user must select odd-number spacing; specifying even number spacing will result in all subridges and subridge valleys on opposite sides of the valley. Even spacing can be made with manual SurvCADD editing. The user can also manually add or delete subridges, or vary subridge longitudinal profiles using Natural Regrade's longitudinal profile editors, to introduce more variation to the draft GeoFluv™ landform.

**Specify head elevation:** The user can specify the head elevation for any channel, rather than accepting an elevation that is automatically determined from the Pre-disturbance file specified in the Settings tab. The user checks the box to select this option and then proceeds in one of two ways. The user can type a desired headwater elevation into the Specify Head Elevation field. Alternately, the user can left-click on the Pick button and then identify a (COGO) point of the desired elevation on the drawing. To use the Pick method, the user left-clicks the cursor near the desired point and then, by moving the cursor diagonally, creates a box around the point. The user left-clicks again to define the opposite corner of the box surrounding the desired point and the point elevation is entered into the Specify Head Elevation field.

**Specify mouth elevation:** The user can (and should) specify the mouth elevation for the main channel only. This setting becomes inactive on the tributary channels because their mouth elevation is controlled by the main channel's longitudinal profile. The procedures for setting the elevation are the same as in Specify Head Elevation above.

[Note: The user should specify the mouth elevation of the main channel in the GeoFluv™ project area because this elevation and the channel slope immediately downstream of this point may be the most critical variables for assuring a stable landform design. The elevations that Natural Regrade interpolates from the 'Pre-disturbed surface' specified in the Settings tab are appropriate for creating and comparing draft design alternatives, but a channel mouth elevation interpolated from a map surface can vary from the actual elevation on the order of feet. A channel will be expected to adjust to elevation and slope inaccuracies by erosion.]

**Channel “Stable Valley R1R1” Settings**

- **Use Rational Runoff Method**: This is the default setting for calculating runoff to the GeoFluv™ channels.
in *Natural Regrade* and is the setting that will be used when the box is checked. The Rational Runoff Method calculates a peak discharge using the formula $Q_{pk} = CIA$, where $C$ is the runoff coefficient, $I$ is the rainfall intensity, and $A$ is the acreage. The user enters the appropriate runoff coefficient for the area within the GeoFluv$^{TM}$ boundary in the Runoff Coefficient field and *Natural Regrade* does all the related calculations.

**Use manual Qpk:** The user can choose to input a peak discharge value calculated by some other method should he wish by checking the 'Use Manual Qpk' option. When the user checks this box, the runoff coefficient field in the Use Rational Runoff Method setting (and use of that method) becomes disabled. The user then types in the peak discharges that he wants to use for the two storm events.

[Note: The GeoFluv$^{TM}$ approach uses the 2-yr, 1-hour storm event to calculate bankfull discharge and the 50-yr, 6-hr event to calculate a flood-prone discharge. Reclamation landforms constructed using the GeoFluv$^{TM}$ approach that use these inputs have been stable in a very harsh and erosive high-altitude desert environment through extreme storm events. Using other input values may give unsatisfactory results.]

**Additional Watershed Area:** This setting allows the user to incorporate runoff from contiguous lands into the GeoFluv Boundary. When the user checks the Additional Watershed Area box, the fields below become active and offer a choice of how the additional runoff will enter the GeoFluv Boundary. If the head of the GeoFluv$^{TM}$ channel is downstream of the Additional Watershed Area, as when joining to an upstream channel reach, the user should select the "At head of channel" option. The GeoFluv$^{TM}$ channel's headwater dimensions will then be sized to accommodate the runoff from the area above the channel headwaters within the GeoFluv Boundary and the Additional Watershed Area upstream of that. If the Additional Watershed Area is subparallel to the GeoFluv$^{TM}$ channel, checking "Evenly along length" will introduce the runoff from the Additional Watershed Area gradually along the GeoFluv$^{TM}$ channel reach and the channel dimensions will increase proportionately along the reach. The remainder of the settings are as described above in "Use Rational Method" and "Use manual Qpk."

**Reread Valley Bottoms**

This command updates GeoFluv with information about changes to the valley bottom polylines (or GeoFluv Boundary polyline).

The valley bottom and GeoFluv Boundary 2D polylines are user inputs for fundamental values to the GeoFluv program. They are used to directly calculate valley length, subwatershed area, and drainage density, and affect discharge calculations and channel dimensions. All commands that need to use these input polylines always check the drawing first and use the current version of these polylines in the drawing. The primary use of this command is to quickly update the data displayed on the Setup tab, the Channels tab and the Output tab after a change has been made in the drawing to either the GeoFluv Boundary polyline or any valley bottom polyline.

**Create Vegetation Scene**

This command places 3D symbols for vegetation for visualization by commands such as 3D Viewer Window and Surface 3D Flyover. This command is layer based where closed polylines on different layers are used to different types of vegetation. The vegetation layers are defined in the dialog shown here. The list shows the layer name, symbol name and parameters for each vegetation type. Use the Add, Edit and Delete functions to manage the list of vegetation. The SaveAs and Load functions store and recall the vegetation definitions to a .veg file. The Draw function creates symbols in the drawing within closed polylines on the vegetation layers using the vegetation parameters for symbol name, size and density. The Hatch functions hatch the closed vegetation polylines as a way to visualize that the vegetation areas are correctly defined. The Create Areas function creates closed polylines on the vegetation layers using the vegetation parameters for slopes and the specified surface model. The Create Layers function creates the vegetation layers in the drawing if they don't already exist.

---

*Chapter 12. Natural Regrade Module*
The Add and Edit functions define the vegetation parameters in the dialog shown here. A preview of the 3D symbol is shown along with the symbol name. To change the symbol, type in a name or pick the Select button to pick from the Symbol Library. There are several 3D symbols for vegetation included in the default install under the 3D Trees category in the symbol library. To add your own symbol to the library, run the Settings->Symbol Library command. The symbols should be created at unit height (height=1) so that the program can scale to the target height. The Layer is used both for the closed polyline for the vegetation area and for the vegetation symbols. Density Per Acre controls how many vegetation symbols to draw with the area. The Min/Max Heights define the range of heights for the vegetation symbols. The program will randomly size the symbols within this range.

The Create By Slope Settings apply to the Create Areas function. The Min/Max Slopes control the range of surface slopes that the vegetation exists. The Start/End Directions control which slope facing directions that the vegetation exists. The directions should be entered in clockwise order. For example, for vegetation that only occurs on south facing slopes, the Start Direction could be set to 90 and the End Direction set to 270.

The Hatch Settings apply to the Hatch functions. These hatch settings include the pattern, layer, color and scale. The Auto Hatch Scale option sets the scale to fit within the area.
When viewing with the 3D Viewer Window or Flyover, use the Apply Surface Smooth, Apply Texture and Display Sky options to improve the image.

**Pulldown Menu Location:** Natural Regrade  
**Keyboard Command:** vegdef  
**Prerequisite:** Closed polylines and surface file
Basic Mining Menus

The Basic Mining module is a subset of the Geology, Underground Mining and Surface Mining modules. The Basic Mining menus have commands for underground mine mapping and quantities, drillhole and strata modeling, and surface design tools. All of the commands for Basic Mining are described in other parts of the manual under Geology, Underground Mining and Surface Mining.

<table>
<thead>
<tr>
<th>Notes</th>
<th>Works</th>
<th>Surface</th>
<th>StrataCalc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Mining Symbols</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate by Bearing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate by Azimuth</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Defaults</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Left/Right/face</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Auto Left/Right</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note from Cool.RD File</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offsets from ASCII file</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Add Drillhole
Bench Marks
Bottom Elev Points
Revise Bottom Elev Points
Mine Name
Section Name
Stoppings
Escapeways (solid circle)
Takeup Date
N-E Line

<table>
<thead>
<tr>
<th>Works</th>
<th>Surface</th>
<th>StrataCalc</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Projections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Projections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projections Ventilation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Booms</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Label Proj. Distances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Panel Label Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Room Label Block</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Outline</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Perimeter</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Pillars</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highlight Unclosed Pillars</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chamber Pillars</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autoblue Connections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-Connect Pillars</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Out</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Boundary Enclosure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configure Section Info</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Place Coal Sections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Edit Coal Sections</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantities by Avg Method</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantities by Grid Method</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quantities by Centrelines</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Tons Acres</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 13. Basic Mining Module
Drillhole Menu

The Drillhole pull-down menu has commands to define, edit and report drillholes, strata and attributes.

Mining Project Manager

This command sets the current file names used for several Carlson definition files. For example, this command assigns the Drillhole Configuration file (.ch file) to be used for drillhole placement in other routines such as Place Drillhole and Drillhole Data Sheet. Mining Project Manager lets you set up different groups of definitions. For example, if you work with two mines, then you can have two sets of strata definitions (strata1.sdf and strata2.sdf), two sets of equipment definitions (equip1.equ and equip2.equ), etc. Mining Project Manager only selects the file names to use. The files are actually created by their own routines. For example, the Define Strata command creates strata definition (.sdf) files. When you run the associated definition routines, these routines load the file names set in Mining Project Manager. For example when you run Define Strata, this routine will load the .SDF file set in Mining Project Manager.

All the file names in Mining Project Manager are saved with the drawing in the drawing .INI file. You can also save this set of file names to a mining project file (.mpj) by picking the Save button. The Load button will then recall the set of file names from the selected .MPJ file.

In SurvCADD 98 and earlier, there was only one file for each of these definition types. You can convert these previous definitions to the new naming format by picking the Recall button. For each old definition file that the program finds, you will be prompted to enter a new file name. For example, in SurvCADD 98 the strata definitions were stored in a file called corehole.dta. If the recall procedure finds a corehole.dta, you can then rename it to the new naming convention of strata.sdf.

Following is a list of commands that will create the files shown in the Mining Project Manager. The extensions of the files are shown in the dialog window below.

1. Drillhole Definition: Define Drillhole
2. Strata Definitions: Define Strata
Define Drillhole

Define Drillhole is a prerequisite to creating, importing and processing drillholes. This is a configuration file containing settings for manual drillhole entry, data storage, predefined attributes and the default key density. There is no geologic data stored in this *.CH file. The following describes each option in Define Drillhole:
• **Drillhole/Strata Attributes:** These are strata and drillhole attributes that can be predefined and set for the drillholes. To enter new ones, select the green + button and type the name in the Attribute field. If they are already defined with the command Define Attributes, then they will appear on the dropdown arrow. Strata attributes can be specific to Key or Non-Key strata. There is no limit to the number of attributes that may be entered. Adding attributes to this list will place this name in each drillhole, whether it has a value or not. Sample attribute names include sulfur, BTU, acid, base, moisture, etc. There are a few reserved names. Attribute FERM is assumed to be a Ferm Code. Another attribute is used to define horizons. This name is defined in Define Horizon Codes and is HORIZON by default. Attribute names that begin with the ‘=’ symbol defines an equation and its value is calculated using values of other attributes. The attribute name LBS may be used in equations to represent strata density. The following are examples of equation attributes, and will be used for processes such as gridding or contouring.

\[ =\text{LBS} \times \text{SULF} / (10^6 \times \text{BTU}) \]
\[ =\text{MOIST} / \text{LBS} \]
\[ =\text{BTU} / 1000 \]

There are three types of strata attributes:
1. - the attributes described in drillhole definition (Define Drillhole, shown here)
2. - the attributes assigned to strata definition (Define Strata)
3. - the attributes added to particular strata in particular drillhole (Edit Drillhole, Drillhole Import, Drillhole Data Sheet) These occur in the file that is imported with Import Drillhole, or manually added with Edit Drillhole.

Such a variety of attribute assignment methods provide high flexibility in attribute usage.

Drillhole descriptions are intended for storing of drillhole specific information in the drillhole. One general drillhole attribute called Description is predefined and others may be defined for specific drillhole descriptions. Typical additional description examples are DRILLER, DATE, TOWNSHIP, and etc. You will be prompted for values of these descriptions in Place Drillhole if they are predefined here.

• **Manual Drillhole Entry Options:** When using the command Place Drillholes to manually enter drillholes, the items to be prompted for can be preset here.

  – **Method to Locate Strata:** Based on what value the user has, there are three choices: Thickness, Elevation or Depth. If importing from an external file, data will come in no matter what is set here, this is just for prompting with Place Drillhole.
Prompt for: When manually placing drillholes with Place Drillhole, there is the option to prompt to enter Non-key strata names such as overburden or parting, a Bed Name (or just the Strata Name) and Drillhole type. During Place Drillholes, each strata must be set as either "Key" or "Non-Key". Then you will be prompted to enter values for the corresponding attribute names if any are entered here. Typically, the ore that is being mines, such as coal, limestone, trona and ore are Key and overburden, partings and waste strata are Non-Key. Distinguishing between Key and Non-Key allows for different sets of attributes and enables the program to calculate the Key to Non-Key strip ratios in the Surface Reserves from drillholes. If there is data only for the key strata, then don't specify the Non-Key option for prompting. This option will prompt for the thickness and elevation of the key strata, and then it will fill in the distance up to the last key strata with a non-key strata named after the key strata's name plus "_OB" at the end. On the other hand, if there is data for all the strata then do turn on NonKey and enter it as well. In this case, either the thickness or elevation of each strata must be entered. Entering both thickness and elevation is not necessary because given one the other can be found from the neighboring strata. So there is a choice to enter each strata by thickness or by elevation. The elevation can be specified as either the absolute bottom elevation or as the elevation difference between the surface elevation of the drillhole and the bottom elevation of the strata. The Bed name option will prompt for the bed name in Place Drillhole. Otherwise the bed names will be set to blank. The Drillhole type option will prompt for the drillhole type number or type name. Otherwise the drillhole type will be set to the first one on the list, 0.

Enter Values in: This also applies to Place Drillhole, prompting for thickness. Set to Inches or Feet/Meter (drawing units), whichever is being entered.

- Use External Database / Database Type: There are a couple of options for storing the geologic data. This setting defines which method to use. If the option is not selected, then the geologic data is stored in the AutoCAD drawing, within the drillhole symbol as extended entity data, stored in the AutoCAD Dictionary. This is a very clean and simple approach, and will run very efficiently. Selecting this option allows for two database options that will be linked live to the drawing. Any changes and edits in the drawing will update the database, and vice-versa. The two types of databases used are SQLite with the CDB file type (Carlson Database), and the Microsoft Access MDB file. The latter is not fully supported and functioning on x64bit machines with AutoCAD. So for faster and better linking, use the SQL approach. If using IntelliCAD, or on an x32Bit PC, then the Access MDB option will work fine. SQLite is an open source database that is widely used. There are many free programs that allow for opening, viewing and editing an SQLite database. One example is shown here that is an add-on for Mozilla Firefox.

- Key Density: The Key Density field is the default density used to calculate key tons in routines like Surface Mine Reserves. In other places in the program, density can also be made strata-specific by using the Define
Strata command. In Surface Mine Reserves, the Use Density Attribute option can be used to model the
density for each strata by using a strata attribute defined in the Precalculated Grids, or in the drillholes. If
neither of those options are used, then this is the value that will be used for tonnage calculations.

- **Restrict Strata/Bed/Attribute Names to Predefined Lists**: This option will not import or use any names
  that don't match up with the predefined names set here, in the Drillhole/Strata Attributes. This allows for a
  filter to not use attributes unless they are defined here.

### Prompts

**Select Existing/New Drillhole Configuration File**: Selection Dialog Box

**Select Drillhole Configuration File** Selection Dialog Box
Specify a file name in which to store the drillhole definition.

**Define Drillhole Dialog**

**Drop-Down Menu Location**: Drillhole

**Keyboard Command**: chdef

**Files**: \lsp\corehole.arx, \lsp\corehole.dcl, \lsp\defcore.lsp

### Define Strata

Define Strata serves several purposes. It is an optional settings/configuration file that defines strata and bed hatch
patterns, Key status, density, conformance modeling settings, and bed splitting settings. Without the strata definitions
predefined, StrataCalc commands will use defaults.

Define Strata is a dialog based spreadsheet editor for strata definitions. The first window shows a list of all of
the currently defined strata. If no strata are yet defined, this table will be empty. This command is used to define both
Strata, such as COAL and Beds, such as C_KEY. To add a new strata definition, click on the Add button. This brings
up the Strata Definition dialog. To edit an existing strata definition, highlight the corresponding line in the table and
then click on Edit button which also brings up the Strata Definition dialog. To edit the same property for multiple
strata such as the Hatch Scale, highlight multiple rows in the spreadsheet by picking with the Ctrl and/or Shift keys,
and then pick the Edit Multiple button. You can also use the standard Windows Copy and Paste functions to edit
cells in the spreadsheet. To remove a definition, highlight the corresponding line and then click on the Remove
button. The Sort button will sort the strata either by name alphabetically, or by following the Geologic Order file.
that is created with the Define Geologic Order command.

The Draw Legend button will draw a legend of the selected strata. The Read Drillholes button will read the selected drillholes and add a default definition for any strata names found in the drillholes that are not already in the table. The Read Pre-Calc button will search the PreCalc for strata names and put them on the list. The Save and Save As buttons exit Define Strata after saving all the changes in the current session to the strata definition file (.sdf file). The Exit button exits Define Strata without saving.

Draw Legend brings up the selection window to choose which items to display in the legend. Then the legend location is selected.

The Column Options button displays the window to select which columns appear in the main Define Strata Screen.
**Strata Name**: This is the strata or bed name that is used to match up with the names in the drillhole. Enter in the strata names exactly as they appear in the drillhole. For bed names, there are four extensions or suffixes that must be added to the bed name to match up with the interval of the bed in the drillhole. They are as follows: LI_TOP, LI_KEY, LI_PARTING, and LI_BOTTOM. These must also be entered below, in the target and marker strata windows, and in the strata split names when using bed names. The strata name may use wildcards. This allows fewer strata definitions. The strata list is automatically sorted to place the most general matches in the end of the list. This concept is illustrated in the following example:

Strata definitions: C1, C?, C*, *

Strata in drillhole: COAL, SAND, C2, C1, C12
Applied Matches:
COAL C* This is the least general match to the COAL. ‘*’=anything
SAND * This word begins with 'S' and all other keys begin with 'C'
C2 C? '?'=any one symbol, so C? is less general than C*
C1 C1
C12 C* C? does not match because of extra symbol on the end.

- **Full Name**: This is the name that will appear as an option in reports and other strata selection windows.

- **Layer**: This is the AutoCAD layer that will be created and used for this strata or bed.

- **Select Color**: This is the color that the solid or hatch pattern will be drawn in for the layer entered above.

- **For Background**: If this is checked, then the background will be a solid fill in the color specified. The hatch pattern will appear on top of it in a black color.

- **Hatch Name**: This is the name of the selected hatch. A preview of it shows up next to the Select Pattern button.

- **Hatch Scale**: This is the scale factor used to size the hatch pattern.

- **Hatch Azimuth**: To rotate a hatch pattern, enter in an azimuth. 90 is horizontal and the default.

- **Density**: Enter in the strata density in pounds per cubic foot or in kg/cubic meter. This is used in Mine Reserves. If no density is set in the strata definition, the program displays "BY_DRILLHOLE" which means that key-strata density of the drillhole will be used. This key-strata density is set by Define Drillhole and can be viewed or modified with Edit Drillhole.

- **Select Pattern**: This button brings up the predefined 127 geologic hatch patterns of Carlson. Each screen with 20 patterns is shown below. Just click on the one to select for each strata or bed.
• **Type of Strata:** The Key or NonKey status can be set here, by strata or bed, which is used by Place Drillholes to determine the type of the user-specified strata name. Also, while entering strata names in Place Drillholes, the strata definitions are checked to see that the strata names are already defined. If the strata name is undefined, the user can define it from there, leave it undefined, or re-enter the name. This check avoids typos and ensures that the strata names match since they should be consistent for the same strata across the drillholes.

• **Recovery Percent:** A recovery can be set for each strata or bed here. It is used in reserves and scheduling.

• **Use for modeling (pinch out/conformance):** Turn on this option if the seam is to be used in modeling the drillholes for pinch out and conformance.

• **Use as seam-specific conformance marker:** Turn on this option if this is a "dominant" marker seam that other seams should conform to if needed.

• **Target strata:** Specify the "target" strata to conform to this marker bed. Enter the strata names, with spaces between the names. If they are beds, use the extensions _TOP, _KEY, _PARTING and _BOTTOM.

• **Select:** This will bring up a strata/bed list dialog box for easy selection.

• **Marker Priority Level:** This is the priority level for the marker bed. For example, the main marker bed A will have a priority of 1 for Seam C. Seam B is the next dominant, so seam B will have a priority level of 2 for seam C.

• **Target of seam-specific conformance:** This is defining the current seam as a target seam for a different marker seam. Meaning this is not the dominant seam, it will conform to another seam.

• **Marker strata:** Just as in Target Strata above, but the opposite applies; enter in the Marker seam for the current seam to conform to.

• **Strata Split Names (Top and Bottom):** Strata can be defined to split for modeling conformance. For example, if A splits into A1 and A2, they should be entered in the Top and Bottom Split windows. So, when modeling, the drillhole that has A will correlate to A1 and A2, with the parting pinching out as it models its way closer to the hole with A. To make sure it is working properly, the seam A should not appear on a list of strata to process. There will only be A1 and A2 for modeling. Grid file utilities and other functions such as limit lines will need to be used to bring them "back" together to get a full A seam.

• **Additional Attributes:** This function will define any attributes specific to that strata, which do not apply to other strata and therefore would be misplaced in the Define Drillhole. The list of attributes for particular strata will be combined from the attributes defined for define Drillhole (key or non-key attributes, depending on the strata type) and attributes defined in Define Strata. In addition the attributes specific for a strata in some drillhole may be added directly to that strata in Edit Drillhole or Drillhole Data Sheet. The equation attributes described in Define Drillhole may be used in this dialog as well.

**Prompts**

**Strata Definitions Table**  
**Strata Definition Edit Dialog**  
**Strata Hatch Patterns**

**Pulldown Menu Location:** Drillhole in Geology, StrataCalc in the Mining menu  
**Keyboard Command:** sdef  
**Prerequisite:** None
Define Lookup Database

Define Lookup Database is a way to predefine drillhole fields such as type, attributes, descriptions and survey quality. Any other custom tables can be defined here for future queries and use.

Examples of the Carlson Tables are:

- **Drillhole Types**: There is no limit to the types of drillholes now. Each can have a different layer, symbol and color for easy viewing on the map. Select the green + button to add more lines.
- **Drillhole Attributes**: Examples for this can be Drillers Name, Date Drilled, County, Mine Area.
- **Bed Names**: Bed Names can be predefined for easy selecting
- **Quality Names**: The type of XYZ survey location for the collar can be predefined here for selecting from the list.

Custom Tables are added to represent any other fields that can have a predefined lookup fields, such as Mine Area, or Lab Company, so they can be easily selected from the list.

**Prompts**
**Define Geologic Order**

This command is to assist the program when partial drillholes are encountered. While this is not a required routine, if many partial drillholes are encountered and the program reports that some strata are out of order, that may be an indication that this routine will help with the correlation. A reference list for strata order is created that all drillholes check to verify the order is correct.

![Image of Define Strata Geologic Order dialog box]

**Pulldown Menu Location:** Drillhole  
**Keyboard Command:** geo_order

**Define Attributes**

This command defines the full name, value range and value type of attributes. This allows StrataCalc commands to identify invalid attributes that fall outside the minimum and maximum value range. Incorrect data entry is detected in Place Drillhole and Drillhole Data Sheet. Use the Attribute Validation Report command under Drillhole, to detect invalid attributes in the existing drillholes.

This routine also defines the data type as numeric or strings. Strings are for non-numerical attributes such as color name. String attributes need to be defined as such before importing the drillholes, otherwise the attribute values, such as green or red, will not import correctly.

For numeric attributes, there are settings to Average By Quantity or Average By Area which apply to Surface Mine Reserves for calculating the average attribute values. The default is to average by quantity which uses the strata quantities to calculate the weighted average. The average by area method uses the strata area as the weighting factor for the average. The average by quantity applies to attributes that you want to average by the strata volume such as BTU. For example, when the strata is thicker who pick up more quantities and the attribute value in these thicker areas should be weighted more. The average by area applies to attributes that count for the presence and not their volume. For example, for an attribute of thickness, you should average by area.

The Number of Decimal Places is used in the Draw Drillhole Text command and for the reports in Surface Mine Reserves. The attribute definitions are stored in a file with an .ATR extension.
Pulldown Menu Location: Drillhole
Keyboard Command: attrdef

Define Equations

This command defines equations using any existing strata attributes and data points as variables. These equations allow you to create new attributes based on a combination of strata data and values. The new attributes can then be used as data models in many routines such as Make Strata Grid or Strata Isopach Maps. This routine is useful for compositing or diluting thickness grids, or generating delivered quality grids in the initial modeling process. Any attribute that is attached to the drillhole attributes, such as water table elevation, or base of weathered zone (horizons that don't belong in the geologic column) can be put into an equation and then gridded to create the surface. After selecting the drillholes, the Define Strata Equations window appears. The selected drillholes are read to find all the available strata and attribute names for the equations. The Define Strata Equations dialog is for adding or removing equations, editing existing ones and loading and saving the equations to a .DEQ file.

User-defined drillhole attributes can now be modeled, such as water table, transgressive horizons or total depth of hole. The first step is to define a drillhole attribute in the drillhole definition file. After the holes have been assigned values for the drillhole attribute, they will appear on the list for Define Equations. If just that one value is selected and added, then if will appear on the list as an equation, capable of being isopached or gridded.
The window for the equation editing and selection has a list of all available equation variables. Equations can also contain values in addition to the drillhole variables. After defining the *.deq file, all routines that list the available strata attributes will have "EQUATIONS" at the top of the list. Selecting that will bring up a dialog window with a list of the user-defined equation names.

**Prompts**

Select the Drillholes to process.
Select objects: pick drillholes to read strata and parameters from
Define Strata Equations Dialog
Pulldown Menu Location: Drillhole
Keyboard Command: chequate

**Define Ferm Codes**

This command defines the table of Ferm codes. Each ferm code is assigned a full name and drawing options. These settings are user-definable and additional Ferm codes can be added. The drawing settings are used to hatch the strata in Draw Geologic Column by matching the strata Ferm code with the Ferm code definitions. Ferm codes are assigned to strata as a strata attribute. To use Ferm codes, each strata should have an attribute called "FERM". The FERM attribute needs to be defined in Define Attributes as a Non-Numeric attribute so that the Ferm code definitions are not limited to just numbers. A Non-Numeric Ferm attribute (a string) allows for Ferm codes containing letters such as 100A. The Ferm code definitions are stored in a file with a .FRM extension. If the window is empty on the initial screen, simply choose load and load the default FRM file from the Carlson DATA folder.

Ferm Codes are lithologic descriptions listed by numeric rock codes (found at http://www.uky.edu/KGS/coal/fermcode.htm), as well as English names. The Ferm codes are derived from the core-logging manual, Cored Rocks of the Southern Appalachian Coal Fields, (http://www.uky.edu/KGS/pubs/SappCoreBook/SAPP.html) by J. C. Ferm and G. A. Weisenfluh from the University of Kentucky.
Define Horizon Codes

This command defines the table of horizon notes. Each horizon note is assigned a unique note number, name, description and processing options. These settings are user-definable and additional horizon notes can be added. The horizon definitions are stored in a file with a .HZN extension.

Horizon notes provide additional information about strata. To assign horizon notes to strata, the strata should have a horizon note attribute. The name of the horizon note attribute is defined in this command at the bottom of the dialog. By default this name is HORIZON, but may be changed. The horizon note from the definition file is matched with the strata by looking up the strata horizon note attribute value in the table. The attribute can be either a number to match by horizon note or a string to match with the horizon name. For example, a strata with an attribute HORIZON and a numeric value of 16 would use Questionable Structure from the table shown below. A strata with a HORIZON attribute of a string value QST would also use the Questionable Structure.
Besides using horizon notes as additional strata descriptors, horizon notes are also applied to strata processing in routines such as Strata Isopach Maps. When reading in the drillholes, if a strata has a horizon note with the Thickness option off, then this strata data will not be used for thickness modeling of this strata. Likewise if a strata has a horizon note with the Elevation option off, then this data point will not be used for elevation modeling of this strata. An application of horizon notes could be with coal section data where you have strata thickness value but the elevation is unknown. In this case, the strata in these drillholes could have a horizon note with the Thickness on and the Elevation off.

Pulldown Menu Location: Drillhole
Keyboard Command: hordef

Import Drillhole
This command imports drillholes into the drawing from a text file or database. There are many company-specific formats that were added many years ago, but now the Custom Import Formatter is flexible enough to handle almost any drillhole text file format. There are also two Carlson Standard Text formats and a Carlson Standard Database format that can be used to import from. The format to use is chosen in the dialog shown here.
The Custom Import Formatter is the most flexible. It will match nearly any text format available, and import the drillholes. To use the Custom format, choose the Custom Import Formatter button. The import text can be comma delimited, single space delimited, tab delimited, fixed width, or Auto-Fixed width. For the fixed width format, choose the Fixed Width toggle and then enter the column numbers separated by spaces in the edit box. For example, "8 15 24 32". The Auto-Fixed width will scan entire file first and detect columns if you have some fixed width format, but do not want to figure what it is. It will detect where breaks between columns are.

The Custom format can import all the drillhole and strata data from one text file or the drillhole (collar) data from one file and the strata (structure and optionally, quality) data from another file. The method to use is set at the *Use separate drillhole and strata files* prompt. The strata file must have either a drillhole name or northing-easting fields to be able to match up the locations with the drillhole file.

The column order is set in the dialog shown above. The first dialog is when importing from one file containing all the data. The next two are when using two files, one for drillhole collar/survey information and the other for structure data. The required fields are Northing, Easting, Surface Elevation, Strata Name and Strata Position (either thickness, elevation or depth).

To add a column field, highlight the field name in the Available list and click the *Add* button.

To add an attribute name that doesn't appear in the Available list such as BTU, click the *Add Attribute* button. Another dialog box appears for entering the attribute name and type as Drillhole or Strata. Drillhole attributes are user-defined fields that apply to the entire drillhole such as "Driller" or "Date Drilled". Strata attributes are user-defined fields for the strata such as "BTU".
The **Add Skip** button makes the program skip that column when reading in the import text file.

The **Avoid Duplicate Strata Names** option will append a number to duplicate strata names within a drillhole if these strata names do not have bed names. For example, if there are three SH strata names, then they would be named SH, SH2 and SH3.

The **Add Only Key Strata** applies to an import file that contains only key strata that have both elevation and thickness fields. The program will then create the key strata and a non-key overburden strata.

The **Fill In Interior or Top/Bottom Bed Names** option will set the bed name for strata that have no bed name to the first bed name found in a strata below the missing bed name strata. If no bed name is found in lower strata, then the program will look for a bed name in the higher strata. In this way, all the strata are assigned bed names. Otherwise only the strata with bed names from the import text file will have bed names in the drillholes.

The **Strata on one row** applies to text files where the entire drillhole is on one row. Each strata is identified by a unique name which is combined with the strata field name. This allows you to have multiple strata value fields such as thickness and name on the same row. For example, consider two strata named COAL_A and COAL_B. When you click the Add button to add the Strata Name, a dialog appears for entering the strata identifier. In this example, you could enter COAL_A. Then click the Add button again for Strata Name and enter id as COAL_B. This creates two strata name fields called COAL_A:Strata Name and COAL_B:Strata Name. Without the Strata on one row option, you can only have one Strata Name per row.

The **Load** and **Save** buttons allow you to save and recall the Custom Import Formatter settings to a settings file with a .IMP file extension. The Preview window below allows for easy matching of the order of items in the text files.

When importing values for the Drillhole Type field, the values should be numbers that range from 0-8 which correspond to the nine different drillhole types defined in Define Drillhole. Likewise, for importing drillhole X-Y Quality and Z Quality fields, the values should be numbers that range from 1-6 the represent the six different quality names as defined in Define Drillhole.
The Carlson Standard Text formats include a complete format that has all the drillhole data options and a simple format that contains the necessary fields. These Carlson format drillhole text files can be created with the Drillhole Export routine. Both formats are shown below. This standard format uses key-coded lines with comma separated entries. String entries are enclosed in single quotes. The first line of the file is a keyword VERSC13.2 to recognize the version of the data file.

The simple standard format does not have all the functionality of the complete format but is easier to create. The program will automatically recognize which format is used. The sample simple format is shown in the first figure below, the complete is the second example. The separate data values on a row are separated by commas in this format. The first line contains the key-strata attribute names and the second line contains non-key strata attribute names. If there are no attributes, these lines would be left blank. Starting at the third line are the strata data lines which continue to the end of the file. A strata data line consists of drillhole name, northing, easting, surface elevation,
strata name, strata bottom elevation, strata type (KEY or NON-KEY), and attribute values if any.

The Carlson Standard Database option is the only format that is a database file and not a text file. This database format is an Access MDB file with TABLE_DRILLHOLE and TABLE_STRATA tables that have the Carlson required fields as described in the Drillhole Database portion of this manual under Define Drillhole. When importing from the Carlson database, you can filter by drillhole name, polyline area or query. To import all the drillholes, use the drillhole name option with a name of "*" for everything. The polyline area option will only import drillholes within...
the selected closed polylines. The query option filters the drillholes by the specified SQL query using the drillhole database fields.

Other Specific Formats are hard-coded imports for data from specific mines. Most were added to Carlson many years ago before the Custom Formatter was available. Now the Custom Formatter will match most any format needed. If there is a format that doesn't follow a pattern that the Custom Formatter can use, then the import can be done by custom programming with these Other Formats. For example, support Carlson Grade's DRL format was recently added.

![Drillhole File Format](image)

**Prompts**

**Select Drillhole Configuration File** .ch file created by Define Drillhole. This dialog appears once. To change Configuration file use Mining Project Manager.

**Choose Format Dialog**

The prompting for other import formats may be different.

**Pulldown Menu Location:** Drillhole > Import/Export Drillholes

**Keyboard Command:** chimport

**Import Qualities**

Many times the lab analysis is received long after the structure data for new drillholes has been entered. This command imports attribute data from a text file into drillholes that are already existing in the drawing. Besides the attribute values, the text file must include the drillhole name or the drillhole northing and easting and a strata or bed name, from and to, or elevations. These values are used to locate where to assign the attribute values.

The order of the columns is set in the dialog shown below. To add one of the standard column types, highlight the name from the Available list and click Add. To add an attribute, click the Add Attribute button. Another dialog will appear for entering the attribute name.

To assign qualities to the drillhole by strata elevation, the program needs both the top and bottom elevation of the sample. This can be done by 2 elevations, by 2 depths or by elevation and thickness. If the sample doesn't match up
with what is in the drillhole, it will split the strata and beds to match up with the sample interval from the quality file. To alleviate this, just use bed name instead of an interval to match up.

Prompts

Select the Drillholes to update.
Select objects: pick the drillholes
Choose Quality Text file to read
Added 30 quality values.

Pulldown Menu Location: Drillhole
Keyboard Command: chimport2

Import Bed Names

This command imports bed names from a text file into drillholes that are already existing in the drawing. Sometimes when importing drillhole information, there is a separate file for lithology. This will bring that file into the holes as a bed name. Besides the bed names, the text file must include the drillhole northing and easting and a strata identifier of thickness, depth, or elevation. These values are used to locate where to assign the bed names. The text file should have comma separated columns of data with each row containing all the data for the strata attributes.

The order of the columns is set in the dialog shown below. To add one of the standard column types, highlight the name from the Available list and click Add. To add an attribute, click the Add Attribute button. Another dialog will appear for entering the attribute name.
Prompts

Select the Drillholes to update.
Select objects: *Pick the drillholes*
Added 107 bed names.

Pull down Menu Location: Drillhole > Import/Export Drillholes
Keyboard Command: chimport3

Coal Section to Drillhole

This command converts the strata data in coal sections into drillhole format. Coal sections are created in the Works pull-down menu of the Standard Mining Module and consist of strata names with thicknesses. Drillholes consist of a surface elevation and strata with top and bottom elevations. Since coal sections contain no real world elevation, the program needs two elevations to assign Z values to make the drillholes. The two elevations are the surface elevation and the top of section elevation. These elevations can be entered for each drillhole or calculated from a surface model defined in a grid file. The top of section elevation represents the top elevation of the first strata in the section. The top and bottom strata elevations for the drillhole are calculated using the top of section elevation and the thicknesses.

The program also prompts for the strata names to use in the drillhole in case the drillhole names differ from the coal sections names. For example, consider this coal section:

C-7
R-3
C-54

In order to avoid duplicate strata names in the drillholes, the two coal section strata named C could be named *Coal 1* and *Coal 2* for the drillholes.

Prompts

Drillhole Configuration File Dialog
Choose a drillhole configuration file (*.ch).

Coal Section Configuration File Dialog
Choose a coal section configuration file (*.sc).

Select coal sections.
Select objects: *pick coal section symbols*

Select Surface Grid
Optionally choose a grid file that models the surface elevation. The drillhole surface elevation will be derived from this grid file. Choose Cancel if there is no surface grid and the program will prompt for the surface elevations.
Select Top of Section Grid
Optionally choose a grid file that models the elevation of the top of the first strata in the coal section. Choose Cancel if there is no top of strata grid and the program will prompt for the coal section elevations.
Enter strata name for section coal <COAL>: press Enter
Is strata COAL key or non-key (<Non-key>/Key)? Key
Enter strata name for section rock <ROCK>: press Enter
Enter DrillHole name: 15-A
Enter DrillHole description: press Enter

Reassign Database File
This command will prompt for the new database file that contains the geologic data of the drillholes on screen.

Prompts
Select the Drillholes to reassign database file.
Select objects: Specify opposite corner: 216 found
Select objects:
Pulldown Menu Location: Drillhole > Import/Export Drillholes
Keyboard Command: chconvert

Convert Drillholes to External Database/Convert Drillholes to Drawing Data
These commands perform a quick and easy two-way conversion from/to internal (DWG) or external (MDB) storage of drillhole data. This is used in converting the drillholes from one format to another. Before running either of these commands, the desired setting whether to use the external database or not must be set in the current drillhole configuration file (*.ch). There are no prompts, just processing time. Verify the conversion with an Edit Drillhole. The method of storage is listed on the screen.
Pulldown Menu Location: Drillhole > Import/Export Drillholes
Keyboard Command: chsetmdb

Export Drillholes
This command creates a standard format text file of drillhole data from drillholes selected from the drawing. There is a choice between the Complete and Simple standard drillhole formats. Examples and descriptions of these formats is in the Import Drillhole section. If you are looking to get the drillholes out into a standard format, such as in Microsoft Excel, then use Drillhole Reports - Custom Drillhole Report and use the Report Formatter to dump them to Excel.

Prompts
Choose text file to create
Drillhole export file format (Simple/<Complete>)? press Enter
Select the Drillholes to export.
Select objects: pick the drillholes
Writing file c:\drawings\data\drillhole.txt
Drillholes to Points
This command creates points in the current coordinate file (.CRD) for the strata data from the selected drillholes. The current coordinate file can be set with the Set Coordinate File command under Points. The x,y position for the point comes from the drillhole position. The z value can be the strata elevation, thickness or attribute. The points can be drawn on the screen in addition to being stored to the CRD file. There is an option to create composite values from multiple strata. The drillhole name can be used as the point number or the description of the points. If the drillhole is not used as the point description, then there is a prompt to specify the point descriptions.

Prompts

Select drillholes and strata elevation polylines.
Select objects: pick the drillholes
Plot the points (<Yes>/No)? N for No
Create composite points (Yes/<No>)? press Enter for No
Use drillhole names for [Point#/Desc/<None>]? press Enter for None
Choose a Strata to Process dialog
Choose Value to Process dialog
Description for points <C2.KEY_BTU>: press Enter

Import/Export Isatis
This imports and exports various entities between Carlson and the Isatis geostatistics program. The Isatis program must be installed or there will be a GTX error. The entities that may be exported are grids, drillholes, polylines, pits and polygons. Entities to import are grids and polylines.
**Place Drillholes**

Place Drillholes generates drillholes in the drawing that are required by the modeling routines. Each drillhole consists of an optional description(s), a surface elevation, and strata. Every strata has a name, bottom elevation, thickness, and optional attribute values and optional bed name. This the manual drillhole entry routine. If the holes are in a file already, then they may be imported with other import routines.

The prompting in Place Drillholes depends on the drillhole configuration file which is created by Define Drillhole. The first step is to select the drillhole configuration file (you only need to do it once, the file name will be remembered for the further use). Then specify the X and Y location of the drillhole followed by the surface elevation and drillhole description. If drillhole definition includes additional descriptions you will be prompted for values, these values are optional, so you may press Enter to continue. After entering this drillhole header information, a loop for entering the strata from top to bottom begins. If an undefined strata name is entered, there is an option to define that strata from there (see Define Strata for more on strata definitions). When all the strata are entered, enter a blank strata name to end the loop, or just hit Enter. This draws the drillhole in the drawing as an INSERT entity in the current DRILLHOLE layer with all the data attached. From there, another drillhole can be entered or the routine can be exited by pressing Enter. At any time in this routine, entering 'Undo' backs up the prompting sequence. The drillhole type is default to unknown with corresponding symbol used in the drawing. The symbols are defined in Define Drillhole and drillhole type may be changed in Edit Drillhole and Drillhole Data Sheet.

**Prompts**

**File Selection Dialog**
Choose a drillhole configuration file.

Enter or Pick Drillhole x,y location (Enter to End): 5000,5000
Enter Drillhole surface elevation ('U' to Undo): 890.3
Enter Drillhole description ('Undo' to Undo): CH-11 This field is optional.
From here begins a loop to enter the strata in top to bottom order.
Enter strata name (Enter to End, 'Undo' to Undo): OV
Strata OV is a Non-Key strata. OV was found in the strata definitions as a Non-Key strata.
Enter bottom elevation of OV ('U' to Undo): 883.7
Now enter the Non-Key attribute values for the attributes defined by Define Drillhole.
Enter value for OV attribute ACID ('U' to Undo): 1
Enter value for OV attribute BASE ('U' to Undo): 2
Enter strata name (Enter to End, 'Undo' to Undo): C
Strata C is undefined? Define now (<Yes>/No)? No Defining strata C is optional.
Is C a Key or Non-Key strata (Key/<Non-Key>/Undo)? Key All must be set as either Key or Non-Key.
Enter bottom elevation of C ('U' to Undo): 879.7
Now enter the Key attribute values.
Enter value for C attribute BTU ('U' to Undo): 10000
Enter strata name (Enter to End, 'Undo' to Undo): press Enter if C is the last strata in the drillhole. Otherwise enter the next strata name.
Enter or Pick Drillhole x,y location (Enter to End): press Enter to exit Or specify another location for the next drillhole.

Pulldown Menu Location: Drillhole
Keyboard Command: chplace

Spot Drillholes

This command creates drillholes from existing drillholes and surface entities or from a predefined PreCalc file. You supply the x,y coordinate for the new drillhole and the routine will calculate the surface elevation and the strata elevations and attribute values based on the other drillholes and surface entities or the grids in the PreCalc. This feature is useful for providing drillers with an estimate of the geologic column drilling exploration holes.

Prompts

Select DrillHole Configuration File (.ch file created by Define Drillhole)
Make Grid File Dialog choose a grid resolution
Select Drillhole Type choose a type
Reading drillhole 42
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Use drillhole surface elevations in surface model [Yes/<No>]? N
Ignore zero elevations [<Yes>/No]? Y
Reading points ... 5365
Ignored 306 points with zero elevation.
Ignored 770 duplicate points.
Inserting breaklines 5684 ...
Triangulating points ... 5365
Assigning grid values > 55000
Pass> 36 Null Z values left > 0
Choose modeling method [<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq]? T
Apply global trend to strata extrapolation [Yes/<No>]? N
Use Triangulation Subdivision [Yes/<No>]? N
Enter or pick drillhole location (ENTER to end):
Enter Drillhole name: Spot1
Enter Drillhole description: Spot
Triangulating points ... 42
Assigning grid values > 55000
Enter or pick drillhole location (ENTER to end):
Edit Drillhole

Edit Drillhole is a dialog based editor for viewing and editing drillhole data one hole at a time. The Edit Drillhole dialog displays the drillhole header information, a list of the strata and intervals and graphical representation of the hole as a geological column that is color matched with the colors defined by the commands Define Strata or Define Grade Parameter, with zoom features. The header information includes the drillhole description(s), the surface elevation and coordinates, drillhole type, survey position quality and elevation sources and the density of the key material in lbs per cubic ft or kg per cubic meter (based on the settings in Drawing Setup).

To edit a strata, highlight the strata in the list or click on the strata in the column to the right, and then click the **Edit** button. You may also double click on the strata to edit it.

To insert new strata, highlight the strata below it and click the **Insert Above** button.

To add a new strata to the end of the list click the **Append to Bottom** button.

Strata are removed by highlighting the strata and picking the **Remove** button.

The **Save** button replaces the existing drillhole entity with a new drillhole and ends the editing session.

The **Surface Elevation** can be set for the drillhole by picking the **Set** button next to the elevation. This will select a surface file that will use the elevation at the drillhole XY to update the elevation.
The source of the data storage is listed above the Description. It will either be in the drawing as EED data linked to the dictionary, or in an external database, with the path listed here. If the data is modified and saved upon exiting, the EED data and the external database will be updated with the changes if that is the path set in Define Drillhole.

Selecting multiple strata in the window with the CTRL button will display the thickness, elevations and depths of the composite lines. This is displayed in the text below the window.

Choosing to Color Strata by Grade, will prompt for a Grade Parameter File, and will color the strata rows as seen here.

- **Descriptions:** Descriptive Fields and Edit Descriptions will bring up the window where additional information about the drillhole can be entered or viewed. This is also where the angle hole data is displayed or entered. The azimuth and dip are entered here with the reserved fields of SC_AZI and SC_DIP. Azimuth 0 is straight up north by default, and the dip of 0 is vertically down, 90 is horizontal, and negative is up. This angle will be applied to the entire hole. If the hole changes by depth, then these fields are entered for each strata interval with the varying azimuth and dip. Other custom descriptions, such as driller's name, date, and minesite can be added here.
Both adding and editing strata brings up the Edit Strata dialog. The Select button next to the strata name brings up the list of strata defined by the command Define Strata. This list of all attributes assigned to strata is displayed, which is combined from attributes defined for the drillhole and for the strata. Attributes which have no value displayed have not been assigned value yet.

An attribute value may be changed by highlighting the attribute line, and simply entering a new value.

Additional attributes may be introduced by filling in attribute name in the left name row and the value in the right edit box.

The attributes defined for this particular strata in particular drillhole may be removed using the keyboards Delete button. The equation attributes may be used as described in Define Drillhole.

To view the attributes of another strata, just pick it on the left. A new Strata is added in the previous window.

The strata thickness and elevation are adjusted according to the selection in the Adjustment Method option in Edit Drillhole dialog whenever the drillhole surface elevation or the strata bottom elevation, thickness or depth has been changed.

Using the Select button next to the Strata Name will bring up a list of predefined strata names to choose from.
Prompts

Select Drillhole to edit [<Pick>/Name]: pick a hole or type "N" and then type in a name. A double-click with the cross-hairs on a drillhole will also execute this command, but only on the edge of the symbol, not the center where the grip is.

Pulldown Menu Location: Drillhole

Keyboard Command: cedit

Drillhole Data Sheet

This function allows you to edit data multiple drillholes in a spreadsheet environment. The editor consists of three inter-linked spreadsheets: drillhole data, seam data and attribute data. The strata information corresponds to the currently selected drillhole in drillhole spreadsheet and in-turn the attribute spreadsheet shows data for the highlighted strata. The information changed in the editor will be saved into drawing or the external database on the exit. There is a prompt whether to save changes when exiting.

In any of the spreadsheets, additional entries may be created by moving down from the lowest line of the spreadsheet. The newly created entry needs to be filled in before another one may be created or before saving the spreadsheet. The Del key removes the highlighted line from spreadsheet. Drillholes deleted from spreadsheet do not get deleted from the drawing, but all changes made to the deleted drillhole are lost. The Ins key inserts an entry above the highlighted one, which is especially handy when you need to insert strata. The Tab key switches between spreadsheets. If an entry is invalid or a compulsory field has not been defined the cursor will stay in that field and a message will display in the bottom line of the editor. The incomplete entry should be finished or deleted before proceeding. Changes between Key and Non-key type of strata may change the set of strata attributes. Therefore the values of some attributes will be lost in the transition.

Using the Edit button next to each drillhole name brings up the Edit Drillhole screen, defined elsewhere in the Help manual.
The appearance of the editor may be modified by hiding unwanted columns using Display pulldown and rows may be hidden by selecting unwanted rows and selecting Edit-Hide. To show rows again select rows above and below and pick Edit-Show. The Options pulldown contains options for units selection and the method of elevation adjustment. These options are saved on the exit, so that next time the editor resets to these defaults.

**Prompts**

**Select Drillhole Configuration File** (this prompt appears once. Use Set Drillhole Definition to change current Drillhole Definition)

**Select Drillholes:** pick Drillholes to load into editor.

**Pulldown Menu Location:** Drillhole

**Keyboard Command:** spread

**Quick Geologic Column**

This command displays a section of drillholes as geological columns that are connected by a polyline fence line. This is an useful command to do quick views of correlations, depths and elevations of drillholes in a section, fence view. Before runing this command, there needs to be a polyline drawn to the drillholes that are to be displayed. The seams colors are specified in the Define Strata command prior to running this command. There are options to Show Elevation Axis on the left, to Connect Strata and Beds, to Label Drillhole Name, and to Label Strata Name. The Vertical Exggeration has an option to fit them to the window, or set the scale.
Prompts

Select Fence alignment polyline: (select the polyline drawn to the holes)
Maximum drillhole distance from alignment polyline <100.0>: (this is the distance it will search from the line to include the holes in the section)

Select Drillholes for geologic column. (select with a window or pick)
Select objects: Specify opposite corner: 6 found

Pull down Menu Location: Drillhole
Keyboard Command: qgeocol

Select Drillholes By Filter

This command creates a predefined selection set of drillholes by filtering them by any available field. The query is defined by either an And/Or. The field names are selected by the dropdown. These items are defined with the command Define Lookup Database, and also include all standard fields of a drillhole, such as name. Inclusion and Exclusion perimeters can also be used to aid in the filter. These are set in the upper right corner by selecting them. The SQL Query appears in the middle window. After choosing the Execute button, the drillholes that meet the criteria show up in the spreadsheet window below. To utilize these drillholes after the query, Save the query and hit OK. Then, at the command line in CAD, when prompted to "Select Objects" enter P (for Previous, or Predefined selection) and it will only use those holes for the operation.

Chapter 14. Geology Module
Prompts

Built selection of 22 drillholes.
To use type 'P' at Select objects: prompt.
Command:

Pulldown Menu Location: Drillhole
Keyboard Command:

Drillhole Core Images

This routine creates a database storing images taken of cores and links them to depths in the holes for reporting and viewing. The command will read both JPG and BMP files. When initially running the command, a prompt will appear to select the file, which creates a DHI file.

Then, in the assignment dialog the drillholes are listed on the left side. The highlighted hole shows up as a column on the right. The intervals for each photo are added to the middle section. Selecting the green + button adds a line in the window. The From and To Elev must be set for each image interval. As each is entered, the core image shows up on the right in the column for each interval. The Diameter controls how wide the column appears on the right.
Reports are generated of all the holes on the list with the Report button. An example appears here.

Prompts
Select drillholes to assign core images.

Select objects: *pick the drillholes*
Drillhole Core Image Dialog
Drillhole Top to Surface Model

This command reports the difference between the selected drillholes and a selected surface model. There is a tolerance that will not include any drillhole within this vertical distance from the surface model.

Prompts

Select the Drillholes for report.
Select objects: all pick the drillholes
Elevation Difference Tolerance <0.0>: 
Use Report Formatter [Yes/<No>]? No will use the standard report window
Reading cell > 49410 Select the drillholes and strata polylines.

Pulldown Menu Location: Drillhole > Reports
Keyboard Command: chreport4
Prerequisite: Drillholes

Pit Channel Samples

Pit/Channel Samples - Import from Text File

This command creates channel samples from comma separated data in a text file. The command starts with a dialog to choose the symbol, symbol size and order of the data columns. Besides the attributes values, the text file must
include the sample northing and easting and a strata identifier of name or elevation. The text file should have comma separated columns of data with each row containing all the data for the sample.

The order of the columns is set in the dialog shown below. To add one of the standard column types, highlight the name from the Available list and click Add. To add a user-defined attribute such as BTU, click the Add Attribute button. Another dialog will appear for entering the attribute name.

Channel Samples can be used as "partial" drillholes or spot samples. They are used in conjunction with the drillholes for modeling.

![Import Channel Samples dialog](image)

**Prompts**

**Import Channel Samples dialog**

**Select Text File dialog**

Created 4 pit/channel samples.

Pulldown Menu Location: Drillhole

Keyboard Command: chansam

**Pit/Channel Samples - Import from CRD File**

This command creates channel samples from points in a coordinate file. Channel samples are strata data points that supplement drillholes. Unlike drillholes, channel samples are not correlated with other strata and are not used for pinch out or conformance. Channel samples represent one strata value such as thickness for strata COAL1. The coordinate file consists of point number, x, y, z data.

The command starts with a dialog to choose the symbol, symbol size and strata attribute name. Then you specify the coordinate file and the range of points to make into channel samples. Similar to drillhole symbols, the channel samples are drawn as the chosen symbol in the CHANNEL layer with the data attached to the symbol. The channel samples can be used in modeling routines such as Strata Isopach Maps or Make Strata Grid Files, by selecting the channel sample symbols along with the drillholes.
Prompts

Import Channel Sample Points dialog
Point numbers to convert: 1-100 or all or *
Point numbers to convert: press Enter
Pulldown Menu Location: Drillhole
Keyboard Command: chansam1

Export Pit/Channel Samples
This command creates a text file of sample data from the selected sample symbols in the drawing. The export file is in the format of Northing, Easting, Description, Strata Name, Attributes. This command is a way to back up the sample data. The export text file can be used to recreate sample symbols using the Import Samples routine.

Prompts

Export Text File to Write Specify a file name
Select samples to export.
Select objects: pick the sample symbols to export
Pulldown Menu Location: Drillhole
Keyboard Command: chansam4

Draw Pit/Channel Sample Text
This command labels the sample data next to the sample symbol. The format and label options are set in the dialog. After selecting the samples to label, the program will read the attribute names from the symbols and prompt at the command line for each one whether to label the attribute.
Prompts

Draw Sample Text dialog
Select samples to label
Select objects: *pick the sample symbols to label*
Label attribute BTU (*<Yes>*/*No*)? *press Enter for Yes*

Pulldown Menu Location: Drillhole
Keyboard Command: chantext

**Place Pit/Channel Sample**

This command creates channel samples at user-specified points and values. The command starts with a dialog to choose the symbol, symbol size, strata name and attribute names. The attribute names to assign are listed in order under the Used list. The Strata Thickness, Bottom Elevation and Top Elevation are the only pre-defined strata attributes. To add one of these attributes to the sample value list, highlight the attribute from the Available list and click Add. All other attributes are user-defined. To add a user-defined attribute, pick the Add Attribute button. Another dialog will appear for entering the attribute name. After filling out the dialog, pick OK. Then you pick the sample positions and enter the sample values at the prompting in the command line. Another option is to use the object snap and select something in the drawing with an elevation, such as a contour. The sample will then use that elevation, thickness or Z value for the sample value.
Prompts

Description «»:
Enter STRATA THICKNESS value: 3.2
Enter STRATA BOTTOM ELEV value: 4598.2
Enter CALCIUM value: 92.4
Pick channel sample location: press Enter
Pulldown Menu Location: Drillhole
Keyboard Command: chansam2

Edit Pit/Channel Sample

This command edits the strata name, attribute name or attribute value of a channel sample. To edit a channel sample, either pick on the symbol after executing the command or simply "double-click" on any sample point. Any changes are saved back to the data attached to the channel sample symbol. The Previous and Next buttons will advance between the different values such as Bottom Elev and Thickness.
Pick channel sample to edit: *pick a channel sample symbol*
Edit Channel Sample Points dialog
Pick channel sample to edit: *press Enter*

Pull-down Menu Location: Drillhole
Keyboard Command: chansam3

**Standard Drillhole Text**

This command draws text for the descriptions, surface elevation, strata names, bed names, thicknesses, attributes, and/or bottom elevations of the selected drillholes. Which values to draw is determined by the selections in the dialog shown below. When bed names are available they may be drawn next to the strata name.

The routine will use Define Strata to determine the full strata name, color and layer name for the strata text. The settings in Define Attribute are used to set the number of decimal places for attributes (i.e. 0 decimals for BTU and 2 decimals for sulfur). If there is no definition, then the text layer and decimals from the Draw Drillhole Text dialog are used.

The layout of the text can also be specified. **Draw attributes on separate lines** will create a new line for each attribute of each strata. Otherwise the attributes of a strata are grouped together on one line and in the **Delimiter** field you can set the text divider such as "/" to use between the values. **Group attributes by strata** will draw all the attributes for a strata together. Otherwise the attributes are grouped by attribute name such as having all sulfur attribute values drawn together.

The **Use Parameter File** option allows you to select a parameter file to filter the drillholes and draw text for only the drillholes that pass the filter. See Define Parameters for more on parameters. The **Draw Strip Ratio** labels the strip ratio for the drillhole from the surface down to the last selected strata. This is a thickness base ratio.

The **Starting Text Position** option allows you to add labels to drillholes with existing labels by shifting the starting text position to an open area. For example, if the drillholes already have two rows of labels, then use a starting text position of three.

**Text Alignment** chooses between drawing the text right justified to the right of the drillhole, center justified above the drillhole or center justified below the drillhole.

**Draw Text At Elevation** creates the labels at the surface elevation of the drillhole. Otherwise, the text is drawn at zero elevation.
Prompts

Draw Drillhole Text Dialog
Select the DrillHoles to label.
Select objects: pick the drillhole symbols
Choose Key Attributes to Draw Optionally choose attributes to label.
Choose Non-Key Attributes to Draw
Drillhole Text Formatter

This routine allows for flexible labeling of any data contained in the drillholes—also known as "posting drillholes." After selecting which drillholes to label, the program prompts whether to process beds. This option will composite the strata by bed name which groups the strata into seams such as bed_top, bed_key, bed_parting and bed_bottom. These composited values are then available for labeling. Without process beds, the strata are reported individually.

The Drillhole Text Format Options dialog is similar to the Drillhole Import routine and other commands in Carlson, where the available options are listed on the left and the used options are added to the right window. All the available strata are listed in the first list box and all the attributes for currently selected strata are listed in the second list box. When the selected available option is added, the next dialog appears for setting the format and location options. The settings can be saved to and recalled from a drillhole text format file.

- **Text Size:** Controls the size of text drawn
- **Text Offset:** Sets the distance from the center of the drillhole to the text
- **Label thickness for missing strata as Zero:** If the seam is not present in a hole, this option will label it as "0.0", otherwise there is no label
- **Prefix layers with drillhole type name:** This adds the Drillhole Type name to the layer as a prefix
- **Skip empty rows:** If a value is not existing in a hole, this option will skip it and go to the next one
- **Overlap labels with same row:** This option, if selected, will start the text at the same location if on the same row
- **Draw text at elevation:** This will draw the text up at elevation of the hole
- **Draw as MTEXT:** Selecting this will group the text as MText (multiline text), otherwise it is separate standard text for each text item.
- **Layer:** Sets the layer for each text line
- **Style:** Sets the text style
- **Color:** Places the text in this color
- **Label Prefix:** Add a prefix to the text, such as BTU: or Thickness:
- **Label Suffix:** Add a suffix such as ft or m
- **Decimals:** Controls the decimals of the values
- **Angle:** Allows to rotate the text, such as straight up, straight down, or 45 degrees etc.
- **Row Position:** Controls the row position counting both up or down from the symbol, based on whether it is set to above or below the symbol
Select the Drillholes to label.
Select objects: *pick the drillholes*
Process beds [<Yes>/No]? *Press Enter for yes.*

Drillhole Text Format Options dialog
Drop-Down Menu Location: Drillhole
Keyboard Command: chtext2

Draw Geologic Column

As the name suggests, this command draws geologic columns for the selected drillholes in both 2D and 3D. There are many options for Draw Geologic Column that are specified in the dialog box. Once you have the settings the way you want, you can save the settings to a geologic column settings file (.geo) that can be loaded later. This settings file allows you to store different schemes of geologic columns. Each setting and option is described separately below.

**Draw...:** The geologic columns can be drawn *In 3D, On 2D Grid or Next to the Drillhole.* For the 3D method, the column is drawn vertically straight down (or at an angle if the Azimuth and Dip are defined for the drillhole) at the X, Y position of the drillhole. This 3D column can be drawn as a cylinder or as flat rectangles as in the 2D grid option except this time in 3D. The settings for 3D are in the 3D Options screen. The *On 2D Grid* option will prompt for a starting position and start drawing the holes in a line from the starting point. When using this option, the next row is active to select the alignment. The *Next to Drillhole* option draws the column on a 2D grid to the right of each drillhole.

**3D Options:** The Column Format has two options to draw in 3D. The cylinder will draw faces that may be rendered in the 3D viewer, while the Rectangle just draws 3D polylines of the drillholes. The Vertical Exaggeration has two options for a starting point, either the Base Elevation entered below, or the Surface. The surface option will scale the
column elevations using the surface elevation as the base point. The base elevation option uses the specified base elevation as the scale reference. The base elevation method is useful for combining the 3D geologic columns with other exaggerated surfaces such as Block Diagram or grid files. For example, you could run Plot 3D Grid Files for a strata elevation grid file with the vertical exaggeration set to 5 : 1 with a base elevation of 500. Then run Draw Geologic Column with the Horizontal Scale as 50 and the Vertical Scale as 10 and the base elevation as 500. To view the 3D columns, use the Viewpoint 3D, Orbit or 3D Viewer Window commands.

Align Horiz by...: For the On 2D Grid method, the location for the geologic columns can be picked individually, lined up or projected. The Individual option will prompt for the location to draw each drillhole. The Line Up option places the geologic columns at an even horizontal interval in the order that the drillholes were selected. For the Line Up method, the Space Scaler field determines the horizontal spacing between the columns. The spacing in drawing units is the Space Scaler multiplied by the Horizontal Scale. The Projected option determines the horizontal alignment by projecting the drillholes onto a polyline and then using the distance along the polyline as the horizontal alignment. Also the Projected option also can draw a surface profile polyline. An offset distance from the horizontal alignment polyline can be set to limit the drillholes selected to just those that fall inside the offset distance. The surface elevations of the geologic columns may not exactly match the surface profile if the drillholes are offset from the alignment polyline.

Space Scaler: When using the Line Up option, this scaler is multiplied by the drawing scale to determine the distance the columns are drawn apart.

Align Vert by...: When using the 2D Grid or Projected options, the geologic columns can be aligned vertically by the real-world elevation, by the surface elevation, or by a strata/bed top or bottom elevation. For example, aligning by the top elevation of strata X would locate all the drillholes such that the top elevation of strata X is drawn in a straight row.
**Draw on Fence Diagram:** The geologic columns can be drawn on a fence diagram. First run the Fence Diagram routine. Then run Geologic Column and choose the Align Horizontally by **Projected** and **Draw on Fence Diagram** options. Also be sure that the horizontal and vertical scales match the fence diagram scale. Then the program will prompt you to select the fence diagram plan-view alignment polyline and the drillholes. Then you pick the lower left grid corner and enter the bottom elevation of the fence diagram grid. The columns should appear on the fence diagram for a visual comparison with the grids that made the fence diagram.

**Strata Name:** This is the strata name that will be used for the above vertical alignment.

**Bed Name:** This is the bed name that will be used for the above vertical alignment.

**From Top Elv and Bottom Elv:** When using the Strata for Align Vert by option, this is the choice for alignment. Either line up the top or bottom elevation of the strata.

**Horizontal Scale:** The Horizontal Scale is the overall drawing scale that many of the options are scaled by. This usually matches the drawing scale set in Drawing Setup.

**Vertical Scale:** The Vertical Scale relative to the Horizontal Scale determines the vertical exaggeration. For example, a Horizontal Scale of 50 and a Vertical Scale of 10 would create 5 to 1 exaggeration. When the Draw Elevation Axis or Draw Depth Axis options are on, the program will draw a vertical elevation and/or depth scale to the left of the geologic column.

**Grid Interval:** The Grid Interval sets the tick mark spacing for the elevation/depth scales. The Grid and Text Intervals can be used as the major and minor axis intervals where the Text Interval in the major and Grid Interval is the minor. The tick mark for the major interval is twice as long. For example, the Text Interval could be 25 and the Grid Interval 5.

**Text Interval:** The text Interval sets the elevation/depth label interval. The Grid and Text Intervals can be used as the major and minor axis intervals where the Text Interval in the major and Grid Interval is the minor. The tick mark for the major interval is twice as long. For example, the Text Interval could be 25 and the Grid Interval 5.

**Draw To Sheets:** This option will work if the options to Draw on 2D, and Align Horizon by individual are set. It draws the individual drillhole on multiple sheets, breaking it by pages set by the scale.

**Draw CESO Sheets:** This option was written for a specific company years ago. It draws the columns on their page form for printing.

**Column Width Scaler:** The Column Width Scaler determines the width of the geologic column by multiplying this value by the Horizontal Scale.

**Text Size Scaler:** The Text Size Scaler sets the text height of the labels by multiplying this field by the Horizontal Scale.

**Hatch Scaler:** The Hatch Scaler is a scaler multiplied by all the hatch scale values when using the Fill By Hatch option.

**Composite Strata to Beds:** This option will composite multiple intervals into one strata by grouping them together by bed name for drawing the column.

**Group Entities:** Selecting this option will draw the drillhole entities as one, as a block in the drawing. If this is off, then all parts of the column are separate entities, such as polylines, hatch and text.

**Offset from Drillhole:** This option is applied when the Draw, Next to Drillhole option is selected. The value is a scaler, and is multiplied with the Horizontal Scale to get the distance.

**Specify Elevation Range - Top Elev / Bottom Elev:** The **Specify Elevation Range** option draws a section of the geologic column within the range of elevations entered to the right. Together with increasing the vertical...
Specify Strata Range - Thickness Roof / Floor: The Specify Strata Range option draws a section of the geologic column within the range of strata. Together with increasing the vertical exaggeration factor, Specify Strata Range can be used to highlight a section of the geologic column. With the strata range option, the program will show a dialog with a list of the strata. You can select multiple strata in this dialog by highlighting the top strata and then picking the bottom strata while holding hold the Shift key. Also for the strata range option, you can specify additional thickness above and below the strata range by using the Thickness Roof and Floor fields. this will add a "roof" and "floor" interval to the column. The Skip to Next will refresh the list of strata by looking at another drillhole with different strata shown.

Draw Bar Graph-Use Red-Blue: The Draw Bar Graph option creates acid-base accounting graphs that are drawn to the right of the geologic column. These graphs are a logarithmic bar graph and a scatter graph. The strata attributes are used as the values for the graphs. The program will prompt for both a key and non-key attribute for the bar graph and the scatter graph. Negative values are drawn to the left on the bar graph and the range of the bar graph is -100 to 100. Values that exceed this range are drawn to the range maximum and then labeled with the real value. The range on the scatter graph is 4 to 8 and values that exceed this range will be drawn off the graph.

Draw Strata Connections: This option will draw lines between the columns to connect the selected strata or beds. This option will display a dialog with a list of strata to choose to connect. Multiple strata can be selected by using the Shift and Ctrl keys while picking the names. The Connect By Bed Name Only option will connect only strata...
that have a matching bed name. Be aware it does not pinch the strata or bed out if it does not appear in a drillhole, it will draw the line right over the hole to the next one. Remove Polyline segment can be used to clean up the drawing.

**Draw Depth Axis:** This option draws a depth grid next to each individual column, or just at the beginning of a row of columns.

**Draw Elev Axis:** This option draws an elevation grid next to each individual column, or just at the beginning of a row of columns.

**No Label:** This option will not label anything next to the columns.

**Label Options:** This button brings up the Label Settings dialog that sets the decimal precision and label prefixes for elevation, thickness and depth. You can also set strata label layer and the grid text layer. The Draw Ferm Codes option will label the ferm code next to the strata name either as the short ferm code name (i.e. "RSS") or as the ferm code full description (i.e. "Red Sandstone"). The ferm codes are defined in the Define Ferm Codes command and the ferm codes are assigned to the strata in the strata attributes. If Ferm codes are used and a corresponding strata attribute is defined, then the ferm hatch pattern, color and layer are used instead.
**Drillhole Options:** This button brings up the Drillhole Label Settings dialog with options whether to label the drillhole northing-easting, drillhole surface elevation, drillhole name and/or drillholes descriptions. There is also an option to label the offset distance from the projection line if the Projection alignment option is used. All of these labels are drawn at the top of the columns, near the collar. You can also set the layer, style and size with scaler, for the drillhole text labels. The drillhole labels can be drawn center justified above the column or to the right of the column.

![Drillhole Label Settings dialog](image)

**Draw as MText:** Using this option will draw the text grouped together as MText (multiline text). Otherwise it comes in as separate entities for each row.

**Label Strata:** This option labels the strata names next to the columns and activates all the labeling options.

**Strata Thickness:** Turn this option on to label the thickness of each interval next to the columns.

**Label Thickness next to Strata Name:** Turn this on to label the thickness on the same line as the name.

**Use Full Strata Name:** This will read the Define Strata settings and label the Full Strata Name found there.

**Label Bed:** This option labels the bed names next to the column. It may be used in addition to the Label Strata Names.

**Bed Thickness:** This will label the bed composite thickness if there are more than one interval of the same bed.

**Label Strata** : To handle crowded strata labels, there are several options for labeling the strata. The **All** option labels all the strata. The **Key-Only** option labels only key strata. The **Bed-Only** option labels only the strata with bed names. The **Fit-Only** option labels only strata with enough thickness to fit the label at the specified label size. The **Selected** option brings up a dialog with a list of strata to choose from.

**Label Strata - Elevations:** This setting will label the top elevation, bottom elevation, or no elevation.

**Label Strata Depths:** This setting will label the top depth, bottom depth, or no depth.

**Label Bed - Elevations:** This setting will label the top elevation, bottom elevation, or no elevation.

**Label Bed Depths:** This setting will label the top depth, bottom depth, or no depth.
**Strata Layer:** This option is active if Strata Layer is set to NonKey Same, or All Same. The layer is entered here. Otherwise, each is drawn in a layer based on strata and bed name. The button next to the window brings up the list of layers to pick from.

**Color Strata by Grade Parameter File:** This option will prompt for the GPF Grade Parameter file. The interval of the drillhole will be colored according to the grade color that is defined in the GPF.

**Layer Strata:** There are three options to set the layers for the entities. Individual will layerize them by the strata names. Non-Key will put just the Nonkey strata on the layer specified above. All Same will put all strata on the layer specified above.

**Fill by:** Solid will fill the columns with a solid fill. Outline will just outline the intervals with no fill or hatch. Hatch will hatch the columns using the predefined hatches in the Define Strata SDF file.

**Use Specific Strata Definitions:** This option will allow for selecting a different Defined Strata file than the one that is set current. Use this option and select a different SDF file for layering, colors and hatching.

**Select Attributes:** If the drillhole has attributes, they can be selected in the Select Attributes window for labeling. They are drawn on the left side of the columns. Key attributes are shown on the left, and Non-Key is on the right side.
A legend for the strata hatch patterns can be created with the Draw Legend function of Define Strata.
Angled Holes:
Carlson will model angled drillholes. There needs to be two attributes added to the drillhole. This is either entered under Drillhole Description to apply the same azimuth and dip to the entire hole, or as a Strata Description if it changes and varies on the way down. The two attributes are SC_AZI and SC_DIP. These represent the Azimuth and Dip of the drillholes. The Azimuth is 0-360 degrees. The Dip is 0-90, with 0 vertically down. Shown below is a 3D view of geologic columns drawn, with the angles shown.


**Prompts**

**Geologic Column Settings dialog**

Select DrillHoles for geologic column.

Select objects: *pick the drillhole symbols*

Select Attributes to Draw dialog

Pick location for geologic column: *pick or enter the bottom center point for the geologic column*

Pulldown Menu Location: Drillhole

Keyboard Command: geocol

---

**Find Drillhole**

This command locates a drillhole by name. The screen is centered around the specified drillhole and a temporary arrow is drawn to it. Be sure that the drawing is not zoomed out too far, as the zoom is not modified, just the panning of the screen to center the drillhole.

---

**Prompts**
Drillhole Inspector

Another inspector command found in Carlson is the Drillhole Inspector. It analyzes the drillholes and displays, in the inspector window, the selected parameters. The first time this command is run, the inspector window (in the top-left) is empty. The user must hit "O" for options to bring up the selection window. The possible parameters to be inspected are selected from the "available" window on the left and added to the "used" window on the right. This routine is very helpful in viewing drillhole data quickly as the cursor is moved across the drawing window, from hole to hole. A dashed arrow is shown in real-time to identify which hole is being inspected.

All drillhole information is available to the list for viewing. This includes such parameters as thickness, elevations, depth, and any user-defined attributes. The "inspector window" in the top-left corner can be moved around the screen by grabbing the title bar at the top and dragging it. The values in the inspector window will change as the cursor is moved over each drillhole. Using the Label option, a label can be posted from available data in the drillhole to a specified insertion point, text size, and alignment.

Prompts
Process beds [Yes/No]? press Enter
Options/<Move pointer near drillhole>: Move cursor over drillholes. Type O to select drillhole options to view. Press Enter to exit.

Pulldown Menu Location: Drillhole
Keyboard Command: chinspect

Apply New Definition
This command allows you to update all drillholes after a change in the drillhole definition file (.CH) is made. The command Define Drillhole creates and modifies the .CH file.

Pulldown Menu Location: Drillhole, Drillhole Utilities
Keyboard Command: chredoall

Change Drillhole Symbol Number
This command will change the actual symbol of the drillhole on screen in the drawing from what was originally placed. The first window that appears is to select the symbol to change to. Click on the symbol desired with the cursor, select the holes to change and the holes are now changed.

Prompts
Symbol Selection Dialog Choose a symbol
Select the Drillholes to change symbol.
Select objects: pick drillhole symbols
Modified 3 drillhole symbols
Pulldown Menu Location: Drillhole
Keyboard Command: chsymbol2

Change Drillhole Symbol Size
This command changes the drillhole symbol size of the selected drillholes to the user-specified size. The diameter of the symbol will be changed to the entered drawing units. Another way to change all the symbols at once, is to change the size in Define Drillhole, then run Apply New Definition.

Prompts
DrillHole symbol size: 50
Select the DrillHoles to resize.
Select objects: pick drillhole symbols
Changed 3 drillhole symbols
Pulldown Menu Location: Drillhole
Keyboard Command: chsymbol

Change Process On/Off Status
This command changes the processing status of the selected drillholes. If the status is off, then they can still appear on screen, but will be ignored for all processing. Drillholes are only used when the status is set to on.

Prompt
Select the Drillholes to set.
Select objects: Specify opposite corner: 42 found
Select objects:
Set processing status [<ON>/OFF]? ON
Modified 42 drillholes.

Pulldown Menu Location: Drillhole
Keyboard Command: chstatus

Change Drillhole Surface Z
This useful command will raise or lower the surface/collar elevation of the selected drillholes either by a surface model file or by an user entered differential. This is necessary when a series of holes have been drilled and surveyed from a local base elevation in the field. Once that benchmark elevation is determined, the selected holes in the drawing can be translated to the appropriate elevation. Older holes located before GPS surveys might not have the correct surface elevation. This will "drape" them onto a surface model file which can be a grid, TIN or FLT file.

Prompts
Select the Drillholes to process.
Select objects: all (to select the drillholes) 190 found
Set elevation by surface model or differential [<Model>/Differential]?
M for Model or Enter if in <>
Reading cell> 251316
Hold strata thickness [<Yes>/No]? y Yes will keep the same thickness of all strata, No will change the thickness of the first strata in the drillhole.
Modified 180 drillholes.
Skipped 10 drillholes already at elevation

OR:
Select the Drillholes to process.
Select objects: pick the drillholes
Enter elevation change: 150. Use a positive value to raise the elevation and a negative value to move down. This example will raise the elevations by 150.
Hold strata thickness [<Yes>/No]? press Enter for Yes If Yes, then the complete stratigraphic column will be moved up or down, keeping the thickness of each the same. If No, then the thickness of the first strata in the hole will be affected; thicker with a positive value as the collar elevation is raised, and thinner if negative.
Modified 15 drillholes.

Pulldown Menu Location: Drillhole
Keyboard Command: chelev

Assign Strata Correlation
This command assigns strata and bed names to intervals in a geologic column view. This is a great tool for a geologist to do the on-screen correlating. Rows of geologic columns can be drawn, and correlated just by "picking" the intervals to connect with lines. Before starting this command, create geologic columns with the Draw Geologic Column command. The Fill option set to Outline Only can make it easier to pick the strata.

While viewing the geologic columns, pick the strata polylines to name on the left or right edge, or they can be selected with a window. Then a dialog appears where you can enter the strata name and an optional bed name. These names are saved back in the drillholes, or in the database. There is an option to connect the strata with the
same names with lines. The one thing it does not do is update the text. The drillholes need to be drawn again to see that update.

**Prompts**

Connect strata with lines (<Yes>/No)? press Enter for Yes  
Select the Strata to name.  
Select objects: pick the strata polylines from the geologic column  
Name Strata Dialog

![Name Strata dialog](image)

Select the Strata to name.  
Select objects: press Enter to end  

**Pulldown Menu Location:** Drillhole in Advanced Mining  
**Keyboard Command:** nmstrata

**Composite Duplicate Strata**

This command will composite all duplicate strata names found within the selected drillholes. To be composited, the strata must have the same bed names, the same key/non-key status and they must be in sequential order without any other strata in between (no partings). There is an option for whether the strata must have the same name. Also, there is an option whether to composite only key or only non-key strata. Since Carlson doesn't model duplicate strata without bed names, this routine can be useful to composite a strata that duplicates itself. The strata qualities will be weight averaged by thickness, giving one value for each attribute.
### Prompts

Select the Drillholes to process.
Select objects: select drillholes to composite duplicate strata
Strata to process [Key/Non-key/<Both>]? press Enter
Require strata name to match [Yes/No]? press Enter
Update 19 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: dupstrata
Prerequisite: Drillholes

### Composite Strata By Beds

This command composites strata within a drillhole based on bed name and key/non-key status. All the non-key strata with a matching bed name that are above the first key strata are composited and assigned the name strata_top. The non-key strata between the key strata are composited as strata_parting. The key strata with a matching bed name are composited as strata_key. The non-key strata below the last key are composited as strata_bottom. This compositing method is the same the StrataCalc uses for processing strata with bed names. The strata qualities will be weight averaged by thickness, giving one value for each attribute.

Before Composite Strata By Beds

<table>
<thead>
<tr>
<th>Strata name</th>
<th>Bed name</th>
<th>Key</th>
<th>Thick</th>
<th>Bot</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROCK</td>
<td>C1</td>
<td>NO</td>
<td>67.00</td>
<td>1684.12</td>
<td></td>
</tr>
<tr>
<td>ROCK</td>
<td>C1</td>
<td>NO</td>
<td>1.00</td>
<td>1683.12</td>
<td></td>
</tr>
<tr>
<td>COAL</td>
<td>C1</td>
<td>YES</td>
<td>1.50</td>
<td>1681.62</td>
<td></td>
</tr>
<tr>
<td>ROCK</td>
<td>C1</td>
<td>NO</td>
<td>0.25</td>
<td>1681.37</td>
<td></td>
</tr>
<tr>
<td>COAL</td>
<td>C1</td>
<td>YES</td>
<td>0.25</td>
<td>1681.12</td>
<td></td>
</tr>
<tr>
<td>COAL</td>
<td>C1</td>
<td>YES</td>
<td>2.00</td>
<td>1679.12</td>
<td></td>
</tr>
<tr>
<td>ROCK</td>
<td>C1</td>
<td>NO</td>
<td>1.00</td>
<td>1678.12</td>
<td></td>
</tr>
</tbody>
</table>

After Composite Strata By Beds

<table>
<thead>
<tr>
<th>Strata name</th>
<th>Bed name</th>
<th>Key</th>
<th>Thick</th>
<th>Bot</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1_TOP</td>
<td>C1</td>
<td>NO</td>
<td>68.00</td>
<td>1683.12</td>
<td></td>
</tr>
<tr>
<td>C1_PARTING</td>
<td>C1</td>
<td>NO</td>
<td>0.25</td>
<td>1682.87</td>
<td></td>
</tr>
<tr>
<td>C1_KEY</td>
<td>C1</td>
<td>YES</td>
<td>3.75</td>
<td>1679.12</td>
<td></td>
</tr>
<tr>
<td>C1_BOTTOM</td>
<td>C1</td>
<td>NO</td>
<td>1.00</td>
<td>1678.12</td>
<td></td>
</tr>
</tbody>
</table>

### Prompts

Select the Drillholes to composite.
Select objects: pick the drillholes to process
Set Strata Key Status

This command processes a given set of drillholes, searches for the information from the selected drillholes and sets key status of each strata with the user-specified name to the required value. This is a much faster way to change key/non-key strata type than going through the Edit Drillhole or Drillhole Datasheet commands. The * wildcard is supported in this command for multiple selections. Bed names can be used as a filter.

Prompts

Select the Drillholes to process.
Select objects: Specify opposite corner: 7 found
Select objects:
Enter name of the strata to modify (wildcards supported): LS*
Enter bed name to limit the selection or press Enter for none:
Set status as [Key/<Non-key>]? K
Modified 7 drillholes.

Fill-in Missing Key as Zero

This command inserts zero thickness key strata when the strata is missing from the geological sequence in the drillhole. This change is permanent to the drillhole, so make sure to have a back up if this is not the desired change. This allows for more control in the pinch out modeling of the drillholes and thickness modeling.

Select the Drillholes to process.
Select objects: Specify opposite corner: 174 found
Modified 12 drillholes.

Add Strata

This routine inserts an interval into the drillholes at either the very top or the very bottom of the selected holes. It is necessary to do this for certain types of geological modeling that have the top or bottom seam disappearing, and not all intervals in the hole have a bed name, such as in this lignite modeling. It "borrows" thickness from either the top or bottom interval, as in this example shown below in the ROCK strata. Some prefer to enter in a 0.1 interval and just call it TOP.
It went from 99 to 98 thick, with the addition of 1 foot of topsoil. This will aid in the modeling of the seam C1 in holes where it does not exist, due to pinch or erosion. This routine should not be used in holes that are drilled in a valley, and the C1 seam is above the collar; it will be modeled with conformance.

**Prompts**

Add strata to top or bottom of drillhole [Top/Bottom]? Top (in this example)
Enter strata name: Topsoil
Enter bed name: Top
Status for strata [Key/Non-key]? N
Enter strata thickness: 1.0
Select the Drillholes to process. Type ALL or select.
Select objects: Specify opposite corner: 22 found
9 were filtered out.
Select objects: press Enter to accept
Updated 13 drillholes:

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: addstrata
Prerequisite: Drillholes

Delete Strata
This command allows you to remove certain strata in multiple drillholes in one step. If strata is removed the thickness of strata removed is added to strata below.

Prompts

Select the Drillholes to process.
Select objects: Specify opposite corner: 20 found
Select objects:
Enter name of the strata to modify (wildcards supported): LS
Enter bed name to limit the selection or press Enter for none:
Modified 20 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: stratadel

Rename Strata
This command allows you to rename a certain strata in multiple drillholes in one step. It prompts for the old strata name and then the new name.

Prompts

Select the Drillholes to process.
Select objects: Specify opposite corner: 20 found
Select objects:
Enter name of the strata to modify (wildcards supported): LS
Enter bed name to limit the selection or press Enter for none:
Enter a new name for the strata: LS1
Modified 20 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: strataren

Reset Invalid Attribute
This command will set the invalid attribute values in the selected drillholes to blank. The range of valid attribute values are set in the Define Attributes command. Any attributes found in the drillholes outside that range are deleted.

Prompts
Select the Drillholes to process.
Select objects: select the drillholes
Modified 309 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: resetattr

Delete Attribute
This routine is a quick and easy way to remove the specified attribute from the drillholes. It will remove the attribute from all the strata in the selected drillholes.

Prompts

Select the Drillholes to process.
Select objects: select drillholes
Enter attribute name to delete: BTU
Modified 219 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: delattr

Rename Attribute
The function of this command is to rename attributes of selected drillholes. This is the only way to globally rename the name of attributes within holes. Be sure to spell the attribute name precisely the way it appears in the holes.

Prompts

Select the Drillholes to process.
Select objects: select the drillholes
Enter old attribute name to rename: CA
Enter new attribute name: CACO3
Modified 35 drillholes.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: renmattr

Assign Bed Names
This command assigns a bed name for each strata with picked names in a given set of drillholes. The strata list is generated based on drillholes selected enabling user to pick multiple strata to process. Hold the CTRL or SHIFT keys to select multiple strata for bed assignment.
Prompts

Select the DrillHoles for bed assignment:
Select objects: Select Drillholes
Enter name for the bed: C1_BED

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: assignbed

Fill-in Bed Names
For some methods of processing the strata modeling routines, the drillhole set should have either no duplicate strata names or bed names assigned for each strata. When bed names are assigned to the key strata (or just some strata within drillhole), the blanks may be filled-in using this routine. The routine works from the top of the drillhole down until it finds the first strata with a non-empty bed name. That bed name is then applied to all strata with empty bed names above that strata. This procedure is then repeated to the bottom of the hole. For the strata below the last strata with bed name assigned, the last bed name is used.

Pulldown Menu Location: Drillhole > Strata/Bed Utilities
Keyboard Command: fillbed

Remove Bed Names After Last Key
For some methods of modeling, users prefer to remove or delete all of the bed names in a drillhole after the last Key interval. This command will do the entire selection set of drillholes at one time.

Prompts

Select the Drillholes for bed process.
Select objects: Specify opposite corner: 11 found
Select objects:
Updated 7 drillholes
Split Bed

For the selected drillholes, this command provides the ability to manipulate an existing bed at certain elevations or thickness. The bed can be split by changing the key/non-key status or by supplying a new bed name. With a new bed name, the bed will be split into one part with the old name and the other with the new name. The elevation at which to split the bed can be specified as a flat elevation or as a grid file. For the grid file, the split elevation is defined by the grid file at the drillhole location. The thickness method allows you to split off a specified thickness from the top or bottom of the bed or to add a specified thickness from the adjoining strata to the top or bottom of the bed. Besides changing the structure (thickness/elevation) of the bed, this routine will also split the bed qualities. 

One application of this routine would be to use the thickness option to set the top 0.1 of the KEY bed to non-key to model loss at the top of the seam. Another application is to split a large KEY bed into two beds at an elevation grid to model mining the bed in two passes or benches.

Prompts

Split strata method [<Elevation>/Grid/Thickness]? T for Thickness
Select the Drillholes for bed split.
Select objects: pick the drillhole symbols
Enter name of the bed to split: C2
Rename bed or assign key/non-key status [<Name>/Status]? press Enter for Name
Enter new name for the thickness change: C2B
Split from top or bottom [<Top>/Bottom]? press Enter for Top
Add or subtract thickness from bed [<Add>/Subtract]? S for Subtract
Enter thickness (ft): 2

By Elevation:
Split strata method [<Elevation>/Grid/Thickness]? press Enter for Elevation
Select the Drillholes for bed split.
Select objects: Specify opposite corner: 5 found
Select objects:
Enter name of the bed to split: C1
Rename bed or assign key/non-key status [<Name>/Status]? N
Enter new name for the upper part of the bed: C1u
Enter new name for the lower part of the bed: C1L
Enter a split elevation: 2510

Rename Bed

This command replaces the old bed name with a new bed name in a selected set of drillholes.

Prompts

Select the Drillholes for bed renaming.
Select objects: Specify opposite corner: 42 found
Select objects:
Enter OLD name of the bed: C1
Enter NEW name for the bed: C-ONE
Statistical Analysis

This command calculates the minimum, maximum, average, slope, and standard deviation of strata values in drillholes or from grids. These values can be the strata thickness, bottom elevation, or user-defined attributes such as BTU or GRADE. The statistics are calculated from either drillholes or a grid file. With drillholes, the statistics are calculated using the drillhole data points. With PreCalc and grid files, the data points are the grid cells. Using a grid allows you to analyze an area by selecting inclusion and exclusion closed polylines of the area. Grid or drillholes both handle pit names for analyzing multiple areas at once. A grid file of a strata attribute can be created with the Make Strata Grid File or Autorun Strata Grids commands. The Statistical Analysis program starts with the option to use Grid, PreCalc or Drillholes. With the Grid option, the grid file (.grd) to process can be selected individually in the standard file selection dialog. The PreCalc option allows you to select multiple grid files from a Pre-Calculated Grids File (.pre) that stores a series of grid files, as shown by highlighting multiple strata at one time. There are options for histogram and Bin size in the reports, as well as marking the outliers in the drawing for detailed review. The report can be viewed in the standard report viewer, or it can be turned on to use the report formatter.
Prompts

For drillhole statistics:
Calculate statistics from grid file or drillholes (Grid/Precalc/<Drillholes>)? press Enter for drillholes
Ignore zero values (<Yes>/No)? press Enter
Select the DrillHoles for report.
Select objects: select the drillhole symbols
Choose Strata to Process
Calculate THICKNESS statistics for strata X (<Yes>/No)? No
Calculate BOTTOM ELEVATION statistics for strata X (<Yes>/No)? No
Calculate BTU statistics for strata X (<Yes>/No)? Yes
Number of samples from drillhole data = 38 Ignored 34 zero values
Average: 10410.42, Standard deviation: 1371.25
Minimum value: 2305.00, Maximum value: 11147.00
Write report to file (Yes/<No>)? Yes
Enter the file name to write: report.txt
Write report to printer (Yes/<No>)? Yes
Make sure printer is on-line and connected to the printer port.

For grid and PreCalc statistics:
Calculate statistics from grid file or drillholes (Grid/Precalc/<Drillholes>)? Precalc
Use named pit areas (Yes/<No>)? press Enter for No
Reading cell > 2989 Choose grid to process
Extrapolate grid to full grid size (Yes/<No>)? press Enter Answer yes to calculate values outside the limits of the data to the full grid size.
Select the Inclusion perimeter polylines or ENTER for none.
Select objects: option to pick closed polylines
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: option to pick closed polylines
Number of samples from grid data = 612
Average: 10457.55, Standard deviation: 816.20
Minimum value: 3464.57, Maximum value: 11111.71
Pulldown Menu Location: StrataCalc
Keyboard Command: chstats
Prerequisite: Drillholes or grids
Standard Drillhole Report

Standard Drillhole Report retrieves data from the selected drillholes and generates a report in the Standard Report viewer that can be edited, printed and saved to file. For each drillhole, the drillhole location, description, strata names, and attributes are reported. There is an option to split the report for page breaks between holes.

Prompts

Select the DrillHoles for report.
Select objects: select the drillhole symbols
Add page break between drillholes [Yes/<No>]? press Enter for No
Place all strata attributes on one line [Yes/<No>]? press Enter for No
Report strata depth to [Top/<Bottom>]? press Enter for No
Report strata elevation of [Top/<Bottom>]? press Enter for No

Pulldown Menu Location: Drillhole > Reports
Keyboard Command: chreport

Custom Drillhole Report

This command builds custom reports of the drillholes. The main difference between this command and Standard Drillhole Report is that this command loads all drillhole data into the report formatter. The report formatter allows you to choose which fields to report and their layout. The report data can be exported to Excel, to Access or into a comma-delimited file, or just saved or printed as shown.
Prompts

Select the Drillholes for report.
Select objects: *pick the drillholes*
Process beds [Yes/<No>]? press Enter for No Process beds will composite the strata by bed name. Otherwise the strata are reported individually.
Separate field names by strata/bed [Yes/<No>]? press Enter for No This option will add the strata name to each
strata data field which allows you to control the report for the strata data separately by strata name. For example, if there were strata named "COAL1" and "COAL2", then you would have field names of "COAL1_THICK" and "COAL2_THICK". Otherwise, there would be only one strata thickness field named "THICK" which would report the thickness for both COAL1 and COAL2.

**Pulldown Menu Location:** Drillhole > Reports  
**Keyboard Command:** chreport2

---

**Change History Report**

This command creates a report of drillholes that have been modified during the specified time period. The program reads the change history from strata attribute variables called DATE_CHANGED and CHANGED_BY. The Edit Drillhole and Drillhole Data Sheet routines will update these changed attributes using the current date and the AutoCAD login name when any of the strata data is modified. For the report if a drillhole contains a changed strata, there is an option to either print all the strata for that drillhole or just the modified strata. To setup the DATE_CHANGED and CHANGED_BY attribute, run the Define Drillhole command and add these names to the Key strata attributes and Non-Key strata attributes.

---

**Prompts**

Select the DrillHoles for change history report.  
Select objects: pick the drillholes  
Enter Period Start Date or Enter for None (mm/dd/yy): 1/1/95  
Enter Period End Date or Enter for None (mm/dd/yy): 9/9/06  
Include only changed strata in affected drillholes (Yes/No)? Y  

**Pulldown Menu Location:** Drillhole > Reports  
**Keyboard Command:** chhreport  
**Prerequisite:** Drillholes
Duplicate Drillhole Report

This command reports drillholes located at the same easting/northing position. The holes can have different names. The report dialog displays the names, and locations of the problem holes. The command has an option to draw a circle, of specified size, around the holes that are found duplicate. The purpose of this routine is to help clean up the drillhole database by identifying duplicate position drillholes since the modeling can only process one drillhole at any one location. This routine only shows the duplicates and it is up to you to actually decide which duplicate drillholes to remove or move. It does not report two drillholes that have the same name, but are at different locations.

Prompts

Draw circle around duplicate drillholes [Yes/<No>]? Y
Circle radius <100.0>: press Enter for 100
Pulldown Menu Location: Drillhole > Reports
Keyboard Command: dupch
Prerequisite: Drillholes

Drillholes without key strata

This routine will report all selected drillholes that do not contain any Key strata. It also will give the option to draw a circle around those drillholes.

Prompts

Draw circle around no-key drillholes [Yes/<No>]? y
Circle radius <100.0>: 50

Chapter 14. Geology Module
Drillhole Top to Surface Model

This command reports the difference between the selected drillholes and a selected surface model. There is a tolerance that will not include any drillhole within this vertical distance from the surface model.

Prompts

Select the Drillholes for report.
Select objects: all pick the drillholes
Elevation Difference Tolerance <0.0>::
Use Report Formatter [Yes/<No>]? No will use the standard report window
Reading cell > 49410 Select the drillholes and strata polylines.

Bed Composite Report

This command reports the individual strata qualities and the resulting composite qualities of drillholes. The strata are composited by bed name. It is useful for seams that are sampled extensively at many intervals, and even with different strata names. An example hole report is shown. Each individual strata and bed is broken out first, with the
composite values following at the end of the report. The command uses the report formatter, so the output it gives is very customizable.

### Prompts

**Select the Drillholes for report.**

**Select objects:** select the drillholes to process

**Pulldown Menu Location:** Drillhole > Reports

**Keyboard Command:** chreport3

---

<table>
<thead>
<tr>
<th>Drillhole name</th>
<th>Northing</th>
<th>Easting</th>
<th>Surface Strata name</th>
<th>Bed name</th>
<th>Key</th>
<th>Thick</th>
<th>Top Elev</th>
<th>Bottom Elev</th>
<th>RAW ASH</th>
<th>RAW SULFUR</th>
<th>RAW BPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>588C</td>
<td>41766.00</td>
<td>171181.00</td>
<td>1610.00</td>
<td>1610.00</td>
<td>USH,DS</td>
<td>Y</td>
<td>00.50</td>
<td>1610.00</td>
<td>1611.50</td>
<td>4.670</td>
<td>12993.000</td>
</tr>
<tr>
<td>588C</td>
<td>41766.00</td>
<td>171181.00</td>
<td>1610.00</td>
<td>1610.00</td>
<td>USH,DS</td>
<td>Y</td>
<td>00.50</td>
<td>1610.00</td>
<td>1611.50</td>
<td>4.670</td>
<td>12993.000</td>
</tr>
<tr>
<td>588C</td>
<td>41766.00</td>
<td>171181.00</td>
<td>1610.00</td>
<td>1610.00</td>
<td>USH,DS</td>
<td>Y</td>
<td>00.50</td>
<td>1610.00</td>
<td>1611.50</td>
<td>4.670</td>
<td>12993.000</td>
</tr>
<tr>
<td>588C</td>
<td>41766.00</td>
<td>171181.00</td>
<td>1610.00</td>
<td>1610.00</td>
<td>USH,DS</td>
<td>Y</td>
<td>00.50</td>
<td>1610.00</td>
<td>1611.50</td>
<td>4.670</td>
<td>12993.000</td>
</tr>
<tr>
<td>588C</td>
<td>41766.00</td>
<td>171181.00</td>
<td>1610.00</td>
<td>1610.00</td>
<td>USH,DS</td>
<td>Y</td>
<td>00.50</td>
<td>1610.00</td>
<td>1611.50</td>
<td>4.670</td>
<td>12993.000</td>
</tr>
</tbody>
</table>

---

**Chapter 14. Geology Module**
Invalid Strata Report

Routines that process strata such as Fence Diagram or Make Strata Grid File require strata names to be in correct order and these routines refuse to continue if there is a problem with the strata. This command creates a report of drillholes that have strata that are out of order or have duplicate strata names. An arrow is drawn on the screen pointing to the drillholes that have the problem. If the screen is moved or zoomed, the arrows will disappear. This report can be used to identify the drillholes that need to be cleaned up.

Prompts

Select the drillholes and strata polylines.
Select objects: pick the drillholes

Pulldown Menu Location: Drillhole > Reports
Keyboard Command: badch
Prerequisite: Drillholes
Missing Strata Report

This command reports strata from the selected drillholes that are missing in the strata sequence. The strata sequence is determined by reading the strata from all the selected drillholes. When a strata is missing between other strata, this is reported as PINCH OUT. For example with strata A, B, C and a drillhole with A, C, then strata B will be reported as pinch out. If a strata is missing before the first strata in the drillhole, then this strata is reported as ABOVE. For example a drillhole with B, C would report strata A as above. Likewise a strata missing after the last strata in the drillhole is reported as BELOW. For example a drillhole with A, B would report strata C as below. In the report, the estimated bottom strata elevation and thickness for the missing strata is reported based on pinch out and conformance.

Prompts

Report pinch out strata [<Yes>/No]? Y
Report strata above or below drillhole [<Yes>/No]? Y
Select drillholes, channel samples and strata polylines.
Select objects: Specify opposite corner: 13 found
Select objects:
Reading drillhole 13
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Drillhole report

PullDown Menu Location: Drillhole > Reports
Keyboard Command: missch
Related Commands: Place Drillholes

Strata Order and Count Report

This command reports all the strata existing in the selected drillholes, in order from top to bottom and the number of drillholes that contain each strata.
Prompts

Select drillholes, channel samples and strata elevation polylines.
Select objects: Select drillholes from the drawing
Pulldown Menu Location: Drillhole > Reports
Keyboard Command: geo_order2

Attribute Validation Report
This command reads the attribute information from the selected drillholes and checks strata attribute values against the minimum and maximum values specified in the attribute definitions. The attribute definitions are created in the Define Attributes command. Any that fall outside the defined range are added to the report.
Attribute Validation report

Prompts

Select the Drillholes for validation report.
Select objects: Specify opposite corner: 13 found
Select objects:
Place all strata attributes on one line [Yes/<No>]? Y
Report strata depth to [Top/<Bottom>]?
Report strata elevation of [Top/<Bottom>]?

Pulldown Menu Location: Drillhole > Reports
Keyboard Command: checkattr
Prerequisite: Drillholes

Define Parameters

This command prepares an attribute parameter definition file (.par file) that defines the attribute names along with an operator and value. The parameter definition files are filters that are applied in the Compliance Drillhole Report, Compliance Areas and Mark Compliance Drillhole commands. The are two types of parameters: Strata and Drillhole. Strata parameters can be THICKNESS, DEPTH, TOP-ELEV, BOTTOM-ELEV, NAME, BED or any of the user-defined strata attributes such as BTU. Drillhole parameters can be NAME, ELEV, DESC, TYPE, XY_QUAL, Z_QUAL or any of the user-defined drillhole attributes such as Driller Name. The TYPE parameter is for the Drillhole Type and it should be referenced by the position number 1-9 and not by name. For example if drillhole type #9 is "Rotary", then in the Value field you should enter 9. Likewise XY_QUAL and Z_QUAL should be referenced by the XY Qualities and Z Qualities position numbers 1-6. Be sure to spell the attributes exactly the same in the parameter list as in the drillholes. The operators are less than, greater than, equal and not equal. When the parameter file is processed the strata attributes are checked with these definitions.

The Strata Name column is optional for assigning a strata name to a parameter. You only need to fill out the Strata Name column if you are analyzing multiple strata at once. For example, you could check THICKNESS on COAL2
strata name and THICKNESS with a different value on COAL3 strata name. If all the parameters apply to the same strata then when you run routines like Mark Compliance Drillholes, there is an option to test the entire drillhole or a specific strata. You can choose the specific strata option and then select a strata to process. Note: You do not fill in the strata name for the first or top parameter. The program will prompt you for the strata to process.

The And/Or field applies between the parameters in the current row and the row above. The Process column allows you to turn off processing for a parameter. Selecting the HELP button on this screen brings up a list of Available Parameters that should be used. This command is CAPS sensitive.
Compliance Drillhole Report

This command reports drillholes from the selected drillholes that meet all the qualities defined in a parameter file. Drillholes that don't meet the parameter file are not reported. There is an option to analyze the entire drillhole or a specific strata. The entire drillhole method will include the drillhole in the report if any of the strata meet the parameter file. The specific strata method checks one strata and includes the drillhole in the report if this strata meets the parameter file. The parameter file consists of strata qualities and values. The qualities can be THICKNESS or any of the user-defined strata attributes such as BTU. Be sure to spell the attributes exactly the same in the parameter list as in the drillholes. Parameter files can be created ahead of time with the Define Parameter command.

Prompts

Parameter Dialog
Process beds [Yes/<No>]? Y
Analyze entire drillhole or specific strata [<Drillhole>/Strata]?
Require all strata to match or any strata [All/<Any>]?
Select the Drillholes to test.
Select objects: Specify opposite corner: 13 found
Compliance Drillhole report

Compliance Areas from Grids

This command draws a closed polyline(s) and hatches the area(s) that meet the specified values for multiple grids. It is similar to the Parameter Compliance from Drillholes, but this analyzes grid files instead of drillholes.

The Set Parameters window is for selecting the grid files and specifying the values to use for compliance. The bottom portion is for choosing the layer, color, pattern and scale for the hatch. The area(s) that meet the criteria are then outlined and filled with the hatch pattern. If no inclusion/exclusion perimeter is selected, then the area of the extrapolated grid is hatched to the limits. As can be verified by the prompts, the command contours each of the
grids for the values specified and then creates closed polygons where the values coincide.

Prompts

Contouring elevation 8000.00
Inserted 686 contour vertices.
Reading file > c:\scad2005\USER\epattern.dta for pattern definitions...
Compliance Areas from Drillholes

This command draws a closed polyline(s) and hatches the area(s) that meet the specified values for parameters. It is similar to the Parameter Compliance from Grids, but this analyzes drillholes instead of grids.

The Set Parameters window is for selecting the parameters and values. In this example, two seams BTU are analyzed, so they are both entered in the Strata Name column.

![Set Parameters Window](image)
Prompts

Use position from another file or pick grid position [Pick/ File]?
Pick Lower Left grid corner <1.45504e+006,1.96932e+006>: 
Pick Upper Right grid corner <1.46634e+006,1.97717e+006>: 
Analyze entire drillhole or specific strata [Drillhole/<Strata>]?
Select the Drillholes to test.
Select objects: all
19 found
Select objects:
Reading points... 18
Reading points... 0
Inserted 19 points.

Pulldown Menu Location: Drillhole > Parameter Compliance
Keyboard Command: charea

Mark Compliance Drillholes
This command highlights drillholes that contain a strata that meets the specified parameters. The drillholes are highlighted by drawing a circle around them, changing the drillhole symbol, changing the drillhole type or changing the drillhole layer. There is also an option to create a selection set of the matching drillholes. Then you can use that selection set in any other command that prompts for drillholes by entering P for Previous at the Select Objects: prompt.

The parameters are set in the Define Parameters window. Be sure to spell the attributes exactly the same in the parameter list as in the drillholes. For more details about parameter definitions, see the Define Parameters command.
Prompts

Set Parameters dialog

Process beds [Yes/No]? press Enter This option composites the strata using their bed names into BED_TOP, BED_PARTING, BED_KEY and BED_BOTTOM. For example, you could have several quality samples of a seam broken into strata names CO with bed name A. The process beds option will composite all these samples into A_KEY. Otherwise the parameter filter will test each sample separately.

Analyze entire drillhole or specific strata [<Drillhole>/Strata]? press Enter The Strata option allows you to select which strata to test. Otherwise all the strata in the drillholes are tested. If Strata is chosen, the Choose Strata window appears for selecting.
Require all strata to match or any strata [All/<Any>]? press Enter. The Any option will mark the drillhole if any of the strata match the parameter filter. The All option requires all the strata to match in order to mark the drillhole.

Select the Drillholes to test.
Select objects: pick the drillhole symbols
Drillhole value to change, create selection set or draw circle
[Layer/Symbol/Type/Selection/Member mode/Draw mode/Circle/]? press Enter for Circle
Mark layer name <COREMARK>?: press Enter for layer
Mark size <25.0>: 100 Enter size.
Marked 7 drillholes.

Pulldown Menu Location: Drillhole > Parameter Compliance
Keyboard Command: charea2
Prerequisite: Drillholes

Set Strata by Parameters

This command sets strata values of strata name, bed name or status (key/non-key) based on whether the strata passed the specified parameter filter. The parameter filter can test strata attributes such as thickness and qualities such as MGO. The change defined in the Set Strata by Parameters dialog will be applied to strata in the selected drillholes that passed the parameter filter. Also in the dialog, you can choose between processing all the strata or specific strata selected by strata name. For example, consider an ore seam that is made of several sequential strata with different quality samples of a strata attribute called GRADE. Set Strata by Parameters could be used to set the key/non-key status of these strata based on whether the strata GRADE attribute is greater than 1.5%.

Prompts
Set Strata by Parameters dialog
Define Parameters dialog
Select the DrillHoles to process.
Select objects: pick the drillholes
Changed 42 strata in 20 drillholes.

Pulldown Menu Location: Drillhole > Parameter Compliance
Keyboard Command: strata_param

Split Bed by Parameters

This command finds the largest portion of a bed such that the composited qualities meet the specified parameter filter. The bed can be split by key/non-key status or by name. With the status method, the bed portion that passes the filter is set key and the rest is set non-key. For the name option, you can specify the bed name for the portion that passes the filter and names for the portions that don't pass.
This command is different from Set Strata by Parameters because this command composites multiple strata to meet
the filter instead of checking each strata individually against the filter. In Split Bed by Parameters, the composited
portion that passes the filter can contain some strata that fail the filter so long as the total composite portion passes.
For example, if the parameter filter is for strata attribute GRADE to be greater the 1.5, then final bed composite
that passes could be made of one strata with GRADE of 1.6 plus part of another strata with GRADE 1.1 such that
the composite GRADE equals 1.5. The strata that make up the bed can be divided into a part that is used in the
composite and part that is discarded. For example in the above case, the strata with the GRADE of 1.1 could be
originally 2 feet thick. Since this strata is below the target GRADE of 1.5, it could be that only 0.7 feet of this strata
could be added to the composite without bringing the composite below 1.5. So the strata would be split at 0.7 feet
with the remaining 1.3 feet not becoming part of the composite.

This command can also account for minimum and maximum mining heights to limit the composite bed thickness.
If there is no portion that meets the filter at the minimum thickness, then the program will find the best portion.
Likewise if the composite that meets the filter exceeds the maximum height, then the program will find the best
portion with the maximum allowed thickness. The thickness interval resolution allows the intervals to be broken up
into as small of units as required. The Find All Matching Zones will not stop at the single best zone, it will separate
the beds into all of the matching zones.

Restrict Mining Zone is an option that defines where the program will start calculating from, either the top or
bottom. For a surface mine, the Top Down would make the most sense, so that the most efficient method of mining
is designed. For underground, it is possible that the Bottom-Up option is preferred, so that extra material will be
left in the roof for support.

Prompts

Split Bed by Parameters dialog
Define Parameters dialog
Select the DrillHoles to process.
Select objects: pick the drillholes
Changed 42 drillholes.

Pulldown Menu Location: Drillhole > Parameter Compliance
Keyboard Command: splitpar
Tag Drillholes for Processing

This command sets the processing status of drillholes based on specified parameters. The processing status is set as ON or OFF which is used by Stratacalc routines to determine whether to include the drillhole in processing. Drillholes have processing ON by default. The drillholes that do not match the specified parameters are tagged as processing OFF. The Reset Selected Drillholes option at the start is a way to set the processing status of the selected drillholes to ON and start fresh, with them all set to ON.

Prompts

Reset selected drillholes to processing on status (Yes/<No>)? press Enter
Define Parameters Dialog
Analyze entire drillhole or specific strata (<Drillhole>/Strata)? press Enter
Select the DrillHoles to test.
Select objects: pick the drillholes
Tagged 20 drillholes ON
Tagged 6 drillholes OFF

Pulldown Menu Location: Drillhole > Parameter Compliance
Keyboard Command: charea4

StrataCalc Menu

The StrataCalc pull-down menu has commands for creating and processing strata models.

<table>
<thead>
<tr>
<th>StrataCalc</th>
<th>Block Model</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Outcrops</td>
<td>Draw Depth Contours</td>
<td></td>
</tr>
<tr>
<td>Strata Grid Files</td>
<td>Isopach Maps</td>
<td></td>
</tr>
<tr>
<td>Strata Quantities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Pre-Calc Grids</td>
<td>Draw Fault Line</td>
<td></td>
</tr>
<tr>
<td>Strata Polylines</td>
<td>Limit Polylines</td>
<td></td>
</tr>
<tr>
<td>Surface Mine Reserves</td>
<td>Underground Mine Reserves</td>
<td></td>
</tr>
<tr>
<td>Grid Utilities</td>
<td>Blending Weighted Average</td>
<td></td>
</tr>
<tr>
<td>Calculate Residuals</td>
<td>Auto-Run Residuals</td>
<td></td>
</tr>
<tr>
<td>Fence Diagram</td>
<td>Block Diagram</td>
<td></td>
</tr>
<tr>
<td>Color Elev Grid By Strata</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

StrataCalc Data Sheet

This command displays geological data for viewing and editing of the processed values in a spreadsheet view. It could be called an interpolator, as it displays the values that the program interpolates and will use for modeling. Each value can be editing and "forced" or user defined values can be used instead of what is found in the drillhole.
or modeled by the program. Each column represents a datapoint, such as a drillhole. The color of each text value
represents the source of the data. This StrataCalc file (*.STC) will then be used for the modeling. Any time the
program prompts "Select Drillholes", if none are selected and Enter is chosen, then the program will ask for the
StrataCalc file. It will use this file and the values in it for the modeling. This is a great tool for controlling the
geology. If a few drillholes are troublesome and not modeling correctly, the user can edit this file to what they
want to use and create a more accurate model. The first window is to choose the source of the data, either the
drillholes on screen, or to load an existing STC file. Then the Data Sheet comes up for viewing and editing.

- **Select Attribute:** The dropdown controls the values to display and edit in the spreadsheet. It will always have
  Thickness, Bottom Elevation and Top Elevation. Any other user defined attributes will also be here for control.

- **Right click to view/change source type:** When placing the pointer on a cell and right clicking the mouse, the
  menu displays the possible sources of the value. The source used is the one with the check mark next to it. The source can be changed by picking a different one, and the color of the text in the cell would then
  change to represent that.
• **Constant Thickness:** If Constant Thickness toggle is ON, then when the user updates the top elevation, the thickness will be kept constant and the bottom elevation will be changed (bot elev = top elev - thick). If the bottom elevation is changed thickness will remain constant and top elevation be changed (top elev = bottom elev + thick). If the toggle is OFF, then if elevation is changed the thickness will also be updated accordingly. (thick = top elev = bot elev)

• **Apply:** This will apply the changes made to the spreadsheet the update the colors and values.

• **Report:** There are three options to see the values in a text report: Report All Data, Report Current Attribute, or Report to HTML. The HTML report takes the current spreadsheet view of the data and puts it into HTML format. The other two reports output to the report formatter.
• **Save/Load to File:** This saves the changes to the STC file, or loads an existing STC file.

• **Read Drillholes:** Choosing this will bring up two options on how the drillholes should be loaded into the spreadsheet. They can either append and merge, or replace the holes if they already exist.

• **Search Drillhole:** To find a drillhole in the spreadsheet, chose this option and enter in the drillhole name. It will scroll to it and highlight the drillhole column of cells.

• **Color Options:** This is a customizable window to set which color the text will be displayed in the spreadsheet. There are seven main sources of the data: Drillhole, Strata Polyline, Channel Samples, Pinchout value, Seam Stacking value, User Defined, and an Invalid Attribute (out of the range of Define Attributes file).
Prompts

chinterp
Select drillholes, channel samples and strata polylines. (select the entities)
Select objects: Specify opposite corner: 294 found
Reading drillhole 294
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Processing only strata with beds.
Attribute Definitions missing (this is because the Define Attributes are empty)

Keyboard Command: chinterp

Draw Outcrops

Draw Outcrops generates polylines that represent the outcrops of strata from the selected drillholes. An outcrop is where a strata comes up to the surface. An option from the Outcrop Settings dialog allows the outcrop line to be calculated from where the top of the strata hits the surface or from where the bottom hits. The Draw Outcrop Polyline At Elevation will draw the outcrops as 3D polylines on the surface topography. For example, on a slope, the top of strata outcrop will be higher than the bottom, and on the inside when viewed in plan view. When coming from drillholes, Draw Outcrops calculates the outcrop by creating a grid of the surface and a grid for the strata and then finding the intersection of the two grids. If the strata never breaks through the surface, no outcrop line will be created. The Pre-Calculated model option reads the surface grid and strata grid from a pre-calculated grid file (.pre). This option will show a dialog with a list to choose from of the strata defined in the pre-calculated grid file. If the File option is used, then a Sub-Crop line can be drawn that will prompt for a thickness grid of the strata. The lines can be smoothed and vertices reduced with the settings shown below.
The option to Label Outcrop Contours will label the strata name in the contour line as contour text. The contour text settings window appears for the desired settings to be entered.
Prompts

Outcrop Settings dialog
Select surface entities & at least 3 drillholes
Select objects: Specify opposite corner: 43 found
Use drillhole surface elevations in surface model [Yes/<No>]？N
Reading points ... 3563
Ignored 5 duplicate points.
Output grids for strata and surface [Yes/<No>]？n
Choose modeling method [<Triangulation>/Inversedist/Kriging/Polynomial/LeastSq/ABOS]？i (or choose another method)
Use inverse distance to which power [First/<Second>/Third/Other]?
Use elliptical inverse distance [Yes/<No>]?
Calculating grid by inverse distances 2601...
Contouring elevation 0.0
Inserted 136 contour vertices.

Drop-Down Menu Location: StrataCalc
Keyboard Command: outcrop

**Draw Depth Contours**
This command creates contours for the depth between the surface and strata. The surface models for the ground and strata are modeled by grid if coming from the screen entities and drillholes. When using the PreCalculated file, the list of strata appears to select which strata to use. Specify Depth Contour Range allows for a starting and ending contour elevation. There is the option to contour the depth to either the top or the bottom of the strata. Options are at the bottom for smoothing and reducing the contour vertices. This is basically the thickness from the topography to the top or bottom of the strata. This grid could also be made in Grid File Utilities, but this is a quick way to get the contours without gridding first.
Pulldown Menu Location: StrataCalc in Advanced Mining and Mining  
Keyboard Command: depth

Make Strata Grid Files
For each strata in the drillhole, this routine can generate 3D grid files of the strata thickness, top & bottom elevation, and attributes such as calcium, moisture, sulfur, and BTU. The grid files make up the geologic model in StrataCalc. A 3D grid file is a rectangular mesh of grid cells where each grid cell is the same size rectangle. The elevation or Z value of the four grid corners equals the value at those points. For example, consider a grid cell for a 3D grid mesh of strata thickness. The X and Y coordinates of a grid cell could be (0,0), (10,0), (10,15), and (0,15). The z values, which might be 4.5, 4.7, 4.8, and 4.6, represent the strata thickness at the four X and Y coordinates.
Make Strata Grid Files reads the strata data from the drillholes. The strata data is correlated and processed for beds, pinch out and conformance as specified in the Configure -Mining Module. The strata data points are then used with the selected modeling method to calculate the grid. There are 5 methods for modeling: Triangulation, Inverse Distance, Polynomial, Kriging and Least Squares. There is an option to use a parameter file (made with Define Parameters) to filter the strata data points. For example, when creating a thickness grid for the overburden of 6_COAL, you could have a parameter filter of THICKNESS 6_COAL > 1.0. This filter would make the program use only drillholes with 6_COAL greater than 1.0 when calculating the 6_COAL overburden grid. See the Define Parameter File command for more description on parameters.

The routine starts by prompting for the location of the grid files to create. The location can be specified by picking the lower left and upper right corners or by selecting an existing grid file which sets the new grid location and resolution to match the selected existing grid file. Next there is the Make Strata Grid File dialog for choosing the grid cell resolution, modeling method and other parameters.

- **Range of Elevations/Values to Process:** Only values that fall within the range specified by the Low and High will be used in the gridding. Values that fall outside this range will be ignored.
- **Modeling Method:** There are 5 modeling methods available for geologic gridding, with many settings for each method. They are Triangulation, Inverse Distance, Kriging, Polynomial and Linear Least Squares. They are described in more detail below.
- **Use Triangulation Subdivision:** When modeling with triangulation, this option will divide each triangle into 3 or more smaller triangles for smoother modeling.
- **# of cells in X and Y / Total Cells:** The Grid Resolution will determine the number of grid cells in the X and Y directions. Most of the time, the user specifies the Dimensions of Cells. This calculates the number of cells in the X and Y direction. Multiplying the two together gives the Total number of Cells. This number determines the processing speed for other commands such as reserves and GFU. A good rule of thumb is to try and keep the Total Cells less than 500,000. Any number larger than this and most processors will use up all the RAM and go to the hard drive and processor, which can slow it down. There is no limit to the grid size though. Every computer is different, so try a few and see which size works for you at a reasonable processing time, and captures the accuracy you need.
- **Grid Resolution:** This is either the number of cells in the X and Y direction or the Dimensions of a Cell in
the X and Y direction. Unless the ore body is long and narrow, the Dimensions of a Cell should match in the X and Y direction creating square cells. In rare instances, rectangles can better model a long, slender ore body.

- **Label Values of Data Points:** This option will draw a label next to each drillhole indicating what value was used at each drillhole for the gridding. Set a Text Layer and Text Size here. This option is a good way to visualize and check the data points that the program is using.

- **Create Data Points Report:** The Create Data Points Report option is another way to check the data points that are used in gridding. This option will create a report of the gridding data points. This report is displayed in the Standard Report viewer where it can be saved, printed or put on screen.

- **Create Composite Grids:** The Create Composite Grids option allows you to select multiple strata or beds to combine instead of gridding the strata individually. With compositing, the program shows the same strata selection dialog with the list of strata but you can now select multiple strata by picking from the strata list while holding down the Shift or Ctrl keys on the keyboard. For composites you can grid the top elevation which is the highest elevation at each drillhole for the composite, the bottom elevation which is the lowest composite elevation, the thickness which is the sum of the thicknesses for all the composite strata, or composited strata attributes.

- **Use Parameter File:** Turning this option on will use a parameter filter file made in Parameter Compliance.

After the grid options dialog, the program prompts you to select the drillholes and fault lines. After reading in the selected drillholes, there is a Choose a Strata to Process dialog to choose the strata to process from the list. If Create Composite Grids was turned on, then multiple strata may be selected here. The All, Key Only and Non-Key Only are just viewing options to reduce the number of strata in the window if there are a lot, for ease of selection.

Once the strata is selected, another dialog shows the strata values and attributes that are available to grid. These will be thickness, elevations, equations, and any quality attributes that are in the drillholes. Choose a value to grid from the dialog.
Then the program will prompt for the grid file name to create (.GRD). Next the program will process the strata data points to create the grid and the results are stored in a user-specified file name. The grids created by Make Strata Grid File can be used as the geologic model for the PreCalculated Grids Definition file. Also the grids can be used in the grid application routines, in the Civil Design module, such as Plot 3D Grid File, Grid File Utilities and Elevation Difference.

Making Strata Grids with Fault Lines
There is an option to select fault lines in addition to the drillholes. The fault lines should be drawn as 3D polylines with elevations that equal the fault differential. The program will grid with all modeling methods using the fault lines for making strata elevation grids. The 3D fault polylines should be drawn such that the left side of the polyline, relative to the direction of the polyline, is the low side of the fault and the right side is the high side. As each grid corner elevation is calculated, the program checks each drillhole. If the drillhole is on the same side of the fault polyline as the grid corner, then no adjustment is made to the drillhole elevation data. Otherwise the drillhole is projected onto the fault polyline and the polyline value at this point on the polyline is used to adjust the drillhole elevation. For example, if the fault polyline value was 5.0 and the grid corner was on the high side of fault while the drillhole was on the low side, then 5.0 would be added to the drillhole elevation for modeling at that grid corner. If the grid corner was on the low side and the drillhole was on the high side, then 5.0 would be subtracted from the drillhole elevation. Reverse Polyline is a good way to reverse the fault line if it is drawn in the wrong direction.

Triangulation Modeling Method
This method is straight triangulation between the drillholes. Triangulation calculates these values by interpolating on the plane defined by the three points in the triangle that encloses the point. Since triangulation only interpolates, it can only calculate values within the area of the data. Afterwards, an extrapolation routine can then fill in the rest of the grid. This extrapolation uses a safe method that tends to average out the data. There is an option to extrapolation to apply the global trend. This option finds the average slope and direction of the existing data and applies this slope to extrapolating.

Inverse Distance Modeling Method
Inverse distance calculates the grid values by assigning weights to the existing data. The grid values calculated by inverse distance are a weighted average of the existing data. Inverse distance will not carry trends and the calculated grid values will never be higher than the highest existing data point. Likewise the calculated grid values will never be lower than the lowest existing data point. The weights are proportional to the inverse of the distance between the point to be estimated and the existing data point. Closer points are weighted more than points farther away. The inverse distance can be calculated to first, second, or third power which are \(1/d\), \((1/d)^2\), and \((1/d)^3\) respectively. The power can also be any user-specified number such as 2.5. The inverse distance estimate is a weighted average with the individual weights computed as an inverse power of distance as follows:
\[ W_i = \frac{d_i^{-\text{power}}}{\sum d_i^{-\text{power}}} \quad I = 1 \ldots \text{number of samples} \]

where \( W_i \) is the weight computed for each sample \( i \), each \( d_i \) is the distance between the location being estimated and sample \( i \), and \( -\text{power} \) is the inverse distance weighting power.

In Configure under Mining there are several options for controlling inverse distance. The Inverse Distance Search Radius is used for calculating a value at a point such that only drillholes that are within this Search Radius will be used in the calculations. The Inverse Distance Max Samples value limits calculations to the nearest specified number of drillholes to the point. For example, the program will use the nearest 10 drillholes. Inverse distance can also be controlled by quadrants which are divided into northeast, southeast, southwest and northwest. The Min Quadrants setting will use at least this specified number of drillholes from each quadrant as long as there are drillholes in the quadrant within the Search Radius. For instance, a setting of Min Quadrants of one would make the program look for at least one drillhole from each quadrant. The Max Quadrants value limits the number of drillholes used from each quadrant. For example if Max Samples was set to 25 and Max Quadrants was 10, then the total samples would be 25 with no more than 10 of the closest ones from each quadrant.

Elliptical inverse distance modeling method is an option that appears any time the Inverse distance modeling method is chosen. The prompt will appear:

**Use inverse distance to which power [First/Second/Third/Other]?** Second

**Use elliptical inverse distance [Yes/No]?** Yes

**Enter azimuth of anisotrophy:** 45

**Enter anisotropic factor:** 1

**Calculating grid by inverse distances 33880...**

This will produce oval shaped inverse distance "bulls eyes" that will use the 2nd weighting power, with the 1st weighting power applied to an azimuth of 45. This option will appear anywhere the Inverse Distance modeling method is selected, such as isopaching.

**Kriging Modeling Method**

Kriging estimates the grid values by figuring the relationship between all the existing data points and then assigning weights to this data. Kriging finds the best fit linear unbiased estimates for the given data and model. Kriging can carry trends within and beyond the limits of the data and can find new high and low values. You must supply a model that defines the spatial relationship of the data which can be difficult. In fact, Kriging is a very complicated subject and you will need to reference an outside source for a detailed description such as *An Introduction to Applied Geostatistics* by Isaaks and Srivastava. Carlson uses Ordinary Kriging. All the parameters for this Kriging are specified in the dialog shown.
Polynomial Modeling Method
The polynomial method is based off of triangulation. The difference is that instead of directly interpolating within each triangle, the polynomial method creates smooth transitions by using a fifth degree polynomial function that accounts for neighboring triangles. Since polynomial needs adjoining triangles, when there are fewer than five data points, there will be fewer than four triangles and the polynomial method will revert to straight triangulation. The same extrapolation logic for triangulation applies to the polynomial method.

Linear Least Squares Modeling Method
The linear least squares method finds the least squares best fit plane at each grid corner. The least squares routine weights each data point by inverse distance so that closer points are weighted more than points farther away. So the best fit plane varies at different points on the surface. The linear least squares method extrapolates trends very well. A lower inverse distance factor (i.e. 1.0) will weigh the data points more equally which models the trends more globally (sometimes called "global dip"). Likewise a higher inverse distance factor (i.e. 3.0) will weigh the closer data points more heavily which models local trends strongly (sometimes called "local dip"). Least squares will trend and allows for data points that are new highs and lows, that don't appear in the original drillhole/point data. It does produce very nice, smooth contours that honor the data points.

Approximation Base On Smoothing (ABOS) Modeling Method
ABOS is a method for modeling values of irregularly spaced points by using a continuous function with two independent variables. This method is developed and implemented by the developer of SurGe, Miroslav Dressler.

The ABOS method uses very simple mathematical tools - numerical tensioning and smoothing. The tensioning and smoothing are performed so that elements of matrix, which represents surface z-values at nodes of a regular rectangular grid, are repeatedly replaced by the weighted average of selected surrounding elements. The selection of elements involved into weighted average depends on the type of tensioning or smoothing. Despite the fact that the mathematics of the ABOS method is simple, the resulting surface can be modified by a few parameters so that it is comparable with the surface created by sophisticated methods such as Kriging, Radial Basis Functions or Minimum Curvature.

Following dialog window shows ABOS parameters that need to be set in order to run ABOS inside the Carlson.
Differential Smoothing Factor:
This parameter enables to control smoothness of generated surface. The larger value, the sharper interpolation is obtained. Typical values are:
0.00 - 0.30 ... for smooth interpolation
0.40 - 0.60 ... for normal interpolation (default value is 0.50)
0.70 - 1000.0 ... for sharp interpolation

Sharp / smooth model at local extremes can be improved by increasing the differential smoothing factor. The accuracy of generated surface decreases with increase in this factor. The zero value produces most smooth surface.

Target Accuracy:
This parameter specifies how accurate the generated surface has to be. It represents the percentage value of average difference between z - coordinates of input points and generated surface from (Zmax - Zmin), where Zmin is the minimum value and Zmax is the maximum value of the z - coordinates of the input points. If the calculated accuracy ((Average DZ / Zmax - Zmin) * 100) is less than the Target Accuracy, the process of interpolation stops and outputs the target grid.

Degree of Linear Tensioning:
This parameter enables to set the degree of linear tensioning. It can have four values:
1. None - for no linear tensioning
2. Medium - for medium linear tensioning
3. Strong - for strong linear tensioning
4. Full - for full linear tensioning

Chapter 14. Geology Module
It is clear from the following figure of cross-section of a grid surface that the surface is more linear for higher degree of linear tensioning.

**Prompts**

Use position from another file or pick grid position (File/<Pick)? press Enter Using the position of an existing file copies the grid resolution and corner point locations to the new grid files. This is useful if you need to have grid files match exactly. Most of the time, grids should match position in the geologic model.

Pick Lower Left grid corner: enter or pick a point

Pick Upper Right grid corner: enter or pick the second point to define the grid position

Make Strata Grid File dialog box

Set the grid resolution and other options. A higher grid resolution increases the processing time. Also choose the Modeling Method in this dialog.

Select drillholes, channel samples and strata polylines.

Select objects: select the drillhole symbols

Select fault lines or Enter for none.

Select objects: press Enter for none, or select the fault lines

Choose Strata to Process dialog

Choose Attribute to Process dialog

Pulldown Menu Location: StrataCalc

Keyboard Command: chgrid

**Define Strata Grids AutoRun**

This autorun-macro type command stores a list of strata to process, the value to process (thickness, elevation or attribute), the process method, grid file name and location. Then the grids can be automatically recalculated for an updated set of drillholes without specifying all these options again. These processing settings are stored in a file with a .run file extension. All of the items described in Make Strata Grids applies here also.
• Edit/Add: This brings up the Strata Grid window for each grid to create. It contains all of the same functions as Make Strata Grids. From this dialog, pick the Choose Strata to Process. This will show a list of strata from the selected drillholes. At this point you can select multiple strata by holding down the Shift or Ctrl keys while picking with the mouse. For each selected strata, the program will create an entry in the list with a default grid file name of the strata name plus the attribute name. So selecting multiple strata is a quick way to fill out the Auto-Run table.

• Once the Choose Strata window is selected, the Attribute or variable to grid needs to be selected.
• Remove/Clear: These options will remove a row from the window and clear will remove all rows.

• Add Row: This will add a new row to the bottom of the spread view.

• Move Up/Move Down: To move rows up or down, choose these options.

• On/Off: If the row is turned on, it will be processed and the grid written. If this is off, no grid is written.

• Make Grids: Once all the options are set and save, the Make Grids button generates the grids.

• Change Directory: This will direct the macro to write the grids to the new directory specified.
• Column Options: This option allows for customized viewing of which columns to display in the window.

• Load/Save/Save As/Exit: These are typical operations for file management.

• Create Data Points Report: This brings up a report of the drillholes or data points and what was used at each point, and the source of the data.

• Run GFU Macros at Completion: If this is turned on and a file is selected, the Grid File Utility will be run at the completion of the Autorun Grids.

• Warning Report Message: If for some reason, some grids cannot be written, there will be an error message at the end of the processing time.
**Prompts**

Select drillholes and strata elevation polylines.
Select objects: *select the drillhole symbols*

**Auto-Run Grid Files dialog**

Pulldown Menu Location: StrataCalc in Geology
Keyboard Command: chgrid2

---

**Run Strata Grids AutoRun**

This command will run the predefined RUN file for making strata grid files. This allows for easier definition of the Autorun macro, without having to wait for the modeling and drillhole processing time.

The Define Strata Auto-Run is where you build the macro file containing the grids to create. It does not have to create them at that time, it just prepares the file to be run at a later time. It is optional to select the drillholes at the beginning of the Define routine. Just hitting Enter will bring up the input dialog.

Run Strata Grids Auto-Run takes the predefined *.RUN file (from Define Strata Grids Auto-Run) and processes it, creating the grid files. As mentioned above, with the previous version in very large datasets, it sometimes took several hours after defining the Auto-Run, to actually select the Make Grids button. Now with this split into 2 routines, you can simply load up the predefined *.RUN file, select Make Grids and leave it over lunch, or overnight, while the modeling calculates the new grids.

---

**Prompts**

Select the RUN file dialog
Select drillholes and strata elevation polylines.
Select objects: *select the drillhole symbols*

Pulldown Menu Location: StrataCalc
Keyboard Command: chgrid3

---

**Strata Isopach Maps**

For each strata in the drillholes, this routine can generate isopach maps, or isolines of the strata thickness, bottom elevation, and attributes such as moisture, sulfur, and BTU. An isopach map is essentially a contour map of the specified strata values.
At the start, there is an option to isopach from either from Grid File or Drillholes From Screen. The file option will contour from stored grid files. In the screen option, the program reads the strata data from the selected drillholes and builds strata models on-the-fly while applying pinch out and conformance as set in Configure, Mining. With the screen method, there is an option to draw labels next to the drillholes for the data values used for modeling which is helpful to visualize the source data. Then the program shows a list of strata. After selecting a strata to process, the program cycles through all the possible strata values. When one of these values is chosen, the contour options dialog box is activated which allows the contouring parameters for the isopach map to be set.

Smooth Contours Setup: The Low to High slider bar controls the amount of smoothing. This smoothing method is based on the Bezier method. The Apply Outlier Reduction Filter option will remove spikes in the contour polylines that don't follow the general trend of the contour. The Reduce Before Smoothing option applies the Reduce Vertices function on the contour polylines before applying the Bezier smoothing. By reducing before smoothing, the contours will have more freedom to smooth since the Bezier method holds all original polyline vertices and the reduce will result in fewer vertices to hold. The Offset Distance is the maximum distance the contour is allowed to shift when removing vertices during reduce. Smoothing Sub-Division will internally subdivide the grid cells with a quadratic smoothing algorithm to help create smoother contours.

The Hatch Zones option will fill in the area between contours with a hatch pattern and color for that zone. For example, hatch zones will create a thickness isopach map with the 0-2 area in blue, 2-4 in green and 4-6 in red etc. The Polyline topology option will create closed polylines of each contour zone. This can be used for GIS type applications in other modules.

The Draw Drillhole Labels option draws text next to each drillhole with the value that was used for contouring. After creating the contours with this routine, the contours can be labeled and highlighted with the contour embellishment commands in the Contour drop-down of the Contour-DTM module. The first window determines the source of the isopach and the modeling process if from drillholes. Use Triangulation Subdivision will be applied to the modeling with triangulation. This process is documented in the Make Grid command. Create Composite Contours will allow for multiple strata to be selected at once, to create a "total coal" thickness isopach for example.

There are two different dialogs, depending if you are contouring from drillholes or a grid. They are both shown below.
### Choose a Strata to Process

<table>
<thead>
<tr>
<th>Strata name</th>
<th>Bed name</th>
<th>Full name</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOP_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
<tr>
<td>OB_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
<tr>
<td>C1_KEY</td>
<td></td>
<td></td>
<td>Key</td>
</tr>
<tr>
<td>C1_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
<tr>
<td>IB_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
<tr>
<td>C2_KEY</td>
<td></td>
<td></td>
<td>Key</td>
</tr>
<tr>
<td>C2_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
<tr>
<td>LS_TOP</td>
<td></td>
<td></td>
<td>Non-Key</td>
</tr>
</tbody>
</table>

**Strata Selection Options:**
- [ ] All
- [ ] Key Only
- [ ] Non-Key Only

[OK] [Exit]

### Choose Value to Process

**Value**

- Thickness (feet or meters)
- Thickness (inches)
- Bottom Elevation
- BTU
- MOISTURE
- ASH
- SUL

[OK] [Exit]
Shown above is an Isopach map with legend using hatch zones. Below is a typical isopach without hatching.

**Prompts**

Select drillholes, channel samples and strata polylines.

*Select objects: pick the drillholes*

Reading drillhole 19
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Select the Inclusion perimeter polylines or ENTER for none.
Select the Exclusion perimeter polylines or ENTER for none.
Create composite contours [Yes/<No>]? n
Triangulating points ... 19
Assigning grid values > 33800
Inserted 336 contour vertices.

Pulldown Menu Location: StrataCalc
Keyboard Command: chiso
Prerequisite: Drillholes

Define Strata Isopach AutoRun

The Define Strata Isopach Auto-Run is for building the macro auto-run file containing the isopachs to create. There is still the option to run the auto-run from here if desired. If there are not any drillholes, for example, you are coming from grids, just hit Enter when prompted to select drillholes.

The first dialog shows the defined isopachs that will be created. There are buttons to Edit, Add and Remove the row. The Sort will sort them in order. Up and Down will move them up or down the list. The On or Off buttons turn them on or off for processing. The Make Isopachs button starts the process and creates the isopach maps. Load and Save/SaveAs will load or create the CTR file. The two entry dialog boxes are slightly different, depending on drillholes or grids.
Following is a description of all the items on the dialog for the Auto-Run Isopach.

- **Processing on**: This needs to be selected to build the isopach. It controls the Process column on the first screen.
- **Strata Name**: This will display the strata name if isopaching from drillholes. If isopaching a grid, then this will be blank.
- **Value to Process**: This is the attribute or item to isopach. It can be an elevation, thickness or any quality attribute. It will be grayed out if isopaching a grid file.
- **Contour Layer**: Enter the layer for the contours.
- **Color**: Choose a color for the contour layer.
- **Contour Interval**: Enter a contour interval. This is for the intermediate contours. Index contours are set below.
- **Smooth Contours**: This toggle will determine if the contours are smoothed. The slide bar controls the smoothing from Low to High.
- **Smoothing Sub-Division Levels**: The smoothing subdivision option will internally subdivide the grid cells with a quadratic smoothing algorithm to help create smoother contours.
- **Reduce Vertices**: This option removes vertices from the contour lines, as long as the contour line does not move more than the Offset Distance from the original location.
- **Drawing File**: There is the option to output each isopach map to its own drawing file. To do this, just select the Choose Drawing File button and enter a drawing name. This name is displayed above the button. If this is not selected, then the isopachs are drawn in the current drawing.
- **Grid File**: The Choose Grid file button is active only if the Modeling Method is set to Grid File. The grid to isopach is displayed above the button.
- **Modeling Method**: There is the option to model the drillholes by Triangulation, Inverse Distance to any power, Kriging, Polynomial and Least Squares. Using a premade grid file is also set here if the drillholes are not used.
- **Draw Index Contours**: Turn this option on to generate the index contours.
- **Set Index Options**: This brings up the Index contour options screen to set the interval, width, layer and color shown below.
• **Label Contours:** This option will label the contours.

• **Set Label Options:** This button will bring up the Contour Label Options screen shown below.

![Contour Label Options](image)

• **Ignore Zero Values:** This option will ignore any zero values for contouring.

• **Range: Min Z and Max Z:** This defines the low and high values that will be contoured. Any values outside of this range will not be contoured.

• **Use Triangulation Subdivision:** When modeling with Triangulation or Polynomial, this will subdivide the triangles into at least 3 smaller triangles for smoother contours.

• **Extrapolate Grid To Full Grid Size:** When modeling with grid files, this option will extrapolate to assign values to any null cells in the grid file.

• **Use Global Trend Extrapolation:** When modeling with Triangulation or Polynomial, this will extrapolate to the edge of the grid limits based on the overall global trend.

• **Set Kriging Parameters:** When modeling the drillholes with Kriging, This button brings up the Kriging Spatial Continuity Model settings screen shown below.
• **Inverse Distance Power:** When modeling the drillholes with Inverse Distance, this is the power that the distance is raised to. It can be any power, including decimals.

• **Elliptical Inverse Distance:** If the ore body is long and narrow, sometimes an elliptical inverse distance modeling method is preferred. This option will allow for two different powers to create an ellipse.

• **Anisotropic Azimuth/Factor:** When using the Elliptical method, this is the azimuth for the second factor, and the second factor power.

**Prompts**

Select drillholes, channel samples and strata polylines or ENTER for None. Select Enter if isopaching only grid files.

Select objects: **all**

61 found

Select objects:

Reading drillhole 194

Finding splits ...

Finding pinch out ...

Calculating seam stacking ...

Select the Inclusion perimeter polylines or ENTER for none.

Select the Exclusion perimeter polylines or ENTER for none.

**Pulldown Menu Location:** StrataCalc

**Keyboard command:** chiso2

**Prerequisite:** Drillholes or grid files

**Run Isopach Maps AutoRun**

This command will execute the predefined Auto-Run Isopach CTR file. It will prompt to select the file, inclusion/exclusion boundaries and the drillholes, then go right into generating the isopachs. It skips the Define Auto-Run step.

**Prompts**

Select Inclusion polyline (Enter for none):
Strata Quantities in Series

For each strata in the drillholes, this command can calculate the volume, tonnage, and average attribute values within a specified area. The possible attributes depend on the configuration set in Define Drillhole. For example, attributes might be moisture, sulfur, BTU, etc. After reading in the selected drillholes, Strata Quantities cycles through all the possible quantities for every strata from top to bottom. Only the desired quantities are calculated and the result is printed out in volume, tons and quality.

Strata Quantities calculates from a 3D grid of the values. The grid resolution is specified in a grid resolution dialog box. A higher resolution yields more accurate results, but slows down the routine.

The area for gathering quantities defaults to the limits of the selected surface entities and drillholes. To control the calculation area, multiple closed polylines for areas to include and/or exclude can be selected. Also, in the first selection for surface entities and drillholes, any selected polylines in the PILLARS layer will be made into exclusion areas and polylines in the PERIM layer will be made into inclusion areas. This is useful for getting quantities from drillholes among pillars and perimeters.
Prompts

Source of surface model [File/<Screen>]? F
Select drillholes
Select objects: Specify opposite corner: 19 found
Select objects:
Reading drillhole 19
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Reading cell > 194032
Pass > 7 Null Z values left > 0
Select the Inclusion perimeter polylines or ENTER for none.
Select objects: 1 found
Select objects:
Select the Exclusion perimeter polylines or ENTER for none.
Select objects:
Choose modeling method [<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq/ABOS]? Triangulation
Apply global trend to strata extrapolation [Yes/<No>]? No
Use Triangulation Subdivision [Yes/<No>]? No
Pre-processing grid cells ...
Ignore zero attributes [<Yes>/No]? No
Triangulating points ... 19
Assigning grid values > 194000
Pass > 148 Null Z values left > 0
Calculate quantities from strata TOP TOP values [<Yes>/No]? Yes
Processing cells ...
Volume of TOP TOP: 306279.7 C.Y.
Avg Thickness: 11.37
Area of TOP TOP: 727302.2 S.F., 16.6966 Acres
Tons of TOP TOP: 620216.5 at Density: 150.00

Chapter 14. Geology Module

Volume of OB TOP: 4311519.5 C.Y.
Avg Thickness: 104.10
Area of OB TOP: 1118291.0 S.F., 25.6724 Acres
Tons of OB TOP: 8730827.1 at Density: 150.00

Volume of Cl KEY: 69031.7 C.Y.
Avg Thickness: 5.98
Area of Cl KEY: 311550.3 S.F., 7.1522 Acres
Tons of Cl KEY: 74554.2 at Density: 80.00
Enter the density of strata TOP_TOP in lbs/ft$^3$ <80.000>: 150
Tons of TOP_TOP: 620216.5 at Density: 150.00
Calculate qualities from strata TOP_TOP values [Yes]/No]? N
Triangulating points ... 19
Assigning grid values > 194000
Pass > 148 Null Z values left > 0
Calculate quantities from strata OB_TOP values [Yes]/No]? Y
Processing cells ...
Volume of OB_TOP: 4311519.5 C.Y.
Avg Thickness: 104.10
Area of OB_TOP: 1118291.0 S.F., 25.6724 Acres
Enter the density of strata OB_TOP in lbs/ft$^3$ <80.000>: 150

Selected Strata Quantities
For each strata in the drillholes, this command can calculate the volume, tonnage, and average attribute values within a specified area. The possible attributes depend on the configuration set in Define Drillhole. For example, attributes might be moisture, sulfur, BTU, etc.

The area for gathering quantities defaults to the limits of the selected surface entities and drillholes. To control the calculation area, multiple closed polylines for areas to include and/or exclude can be selected. Also, in the first selection of drillholes, any selected polylines in the PILLARS layer will automatically be made into exclusion areas and polylines in the PERIM layer will be made into inclusion areas. This is useful for getting quantities from drillholes among pillars and perimeters.

This command is similar to the Strata Quantities in Series command. The difference is that this command does not process the strata in sequence from top to bottom. Also this command does not model the ground surface. Instead Selected Strata Quantities allows you to select the strata to process from the list of available strata. The advantage is that when there are many strata, you don't have to cycle through all the top strata to get down to a specific strata. Since the ground surface is not calculated, the disadvantage of this command is that the outcrop for the selected strata is not automatically calculated. The volume for the selected strata is calculated using the strata thickness and the calculation area. To limit the volume calculations to be inside the outcrop, draw the outcrop as a closed polyline which can then be used as an inclusion perimeter.
Another advantage of this command verses Strata Quantities in Series is that composite quantities can be calculated. Composite quantities allow you to select multiple strata and add their thickness together for the volume report. Also the weighted average of the attributes is calculated.

Prompts

Select drillholes, channel samples and strata polylines.
Select objects:
Reading drillhole 19
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Select the Inclusion perimeter polylines or ENTER for none.
Select objects:
Select the Exclusion perimeter polylines or ENTER for none.
Select objects:
Choose modeling method [<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq/ABOS]? /
Use inverse distance to which power [First/<Second>/Third/Other]?
Use elliptical inverse distance [Yes/<No>]?
Pre-processing grid cells ...
Ignore zero attributes [<Yes>/No]?
Create composite quantities [Yes/<No>]?
Calculating grid by inverse distances 33880...
Processing cells ...

Enter strata C1_KEY density in lbs/ft\(^3\) <80.000>:
C1_KEY Volume: 104804035.8 C.F., 3881631.0 C.Y., Avg Thickness: 1.25
C1_KEY Area: 83767500.0 S.F., 1923.0372 Acres
C1_KEY Tons: 4192161.4 at Density: 80.00
Calculate qualities from strata C1_KEY values [<Yes>/No]? Y
Press ENTER to continue.
Calculating grid by inverse distances 33880...
Processing cells ...
Enter strata C2_KEY density in lbs/ft\(^3\) <80.000>:
C2_KEY Volume: 159623387.6 C.F., 5911977.3 C.Y., Avg Thickness: 1.91
C2_KEY Area: 83767500.0 S.F., 1923.0372 Acres
C2_KEY Tons: 6384935.5 at Density: 80.00
Calculate qualities from strata C2_KEY values [<Yes>/No]? Y

Pulldown Menu Location: StrataCalc
Keyboard Command: chquan2

**AutoRun Strata Quantities**

This command stores a list of strata to process, the value to process (volume or attribute) and the process method. It is the Auto-Run macro of the Selected Strata Quantities command. By clicking the Calculate Quantities button, the quantities for each item in the list can be calculated automatically without specifying all these options again. This routine allows you to save many steps when recalculating volumes for updated drillholes or different inclusion areas. These processing settings are stored in a file with a .VOL file extension.
Prompts

Select drillholes, channel samples and strata polylines.
Select objects: Specify opposite corner: 48 found
Select objects:
Reading drillhole 42
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Calculate VOLUME for strata [<Yes>/No]? Y
Auto-Run Quantities dialog
Pulldown Menu Location: StrataCalc
Keyboard Command: chquan3

Define PreCalculated Grids

This command assigns grid files to strata names in sequence. This list of grid files represents the geologic model of the strata. The Make Strata Grid File or Auto-Run Strata Grids commands can be used to create the grids before running this routine. The Pre-Calc grid assignments are stored in a user-specified file name with the .pre file extension. There are two types of Pre-Calc files: elevation and thickness. When creating a new Pre-Calc file, you have the choice between elevation and thickness. Once the Pre-Calc file is created, the type cannot be changed.

For elevation type Pre-Calc files, the grid files define the bottom elevation surface model for the corresponding strata. A grid file for the ground surface model is also assigned in this routine. The surface grid can be created with the Make 3D Grid File routine in the Civil Design module. When the Pre-Calc file is applied in StrataCalc volume calculations, the strata thickness is determined by comparing the current strata bottom elevation grid with previous upper strata or surface grid. Shown below is an elevation example.
With thickness type Pre-Calc files, the grid files represent the thickness for the corresponding strata. A surface grid file is not specified. Without the ground surface elevation grid, the StrataCalc routines cannot find outcrops or adjust the strata thickness for variations on the surface. So the thickness grids that you supply the Pre-Calc file must account for the outcrops and ground surface variations. To account for outcrops, you can set the thickness grids to zero in outcrop areas by using a closed polyline for the outcrop areas and running Grid File Utilities-Set Value with the Use Inclusion Areas option. A thickness PreCalc will not draw proper Fence Diagrams. To account for surface variations, you can make a grid of the ground surface and a bottom elevation grid of the top strata overburden. Then use Grid File Utilities to subtract the top strata elevation grid from the ground surface. The resulting difference grid is the top strata thickness. Shown below is a thickness example.

All these grid files should have the same location and resolution. They can vary for some commands, such as Surface Mine Reserves. To ensure the same grid position, use the File option at the Use position from another file or pick grid position prompt when making the grid files. The pre-calculated grids are specified in the dialog shown below. The surface grid is defined in the top of the dialog. To assign the surface grid, pick the Select Grid File button in the upper right. Next there is a list of the strata names and the corresponding grid files. To add a strata grid assignment, highlight the strata above the one to add and click the Add button. This brings up the next dialog where you enter the strata name and grid file. Besides elevation and thickness grids, attribute grids such as BTU can be assigned to
the strata names. In the Pre-Calculated Grid Definition dialog, click on the Attribute toggle and enter the Attribute Name. The strata in this list should be listed in top to bottom order. If a strata is out of order, highlight the strata in the list and click the Move Up or Move Down button.

The Load Auto-Run button will prompt you to select an Auto-Run Grid Definition File (.run). The program will then read the strata names from this file and build the Pre-Calc Definition list. The Reset Directory button allows you to reassign the grid files directory in case the grid files have move since the Pre-Calc file was created. Select the grid file at the top of the window, usually the first grid on the list. The surface grid will have to be redirected separately. The Extrapolate will extrapolate and save all the grids to remove NULL values. This option will save time in StrataCalc routines that use the Pre-Calc file and extrapolate the grids on-the-fly each time. There is an option to extrapolate by merging or flattening (pancaking) elevation grids with upper strata. The “pancaking” is an option using the Extrapolate function. It will assign the Nulls in a grid the elevation of the strata above. This change is saved to the .GRD file. The other option will just extrapolate the grid elevation out to the grid limits.

The purpose of this routine is to allow you to process stored grids in routines such as Surface or Underground Reserves and Fence Diagram. These commands have a Pre-Calculated Grid option under the modeling methods. Otherwise these routines will read selected drillholes and calculate the strata models on-the-fly. The advantage to pre-calculated grids is that you have more control over the geologic models. After creating the strata grid file, there are many routines that can be used to analyze and modify the grids to make sure that the grids model the strata the way that you want, and even create a mining model from modifying the geologic grids. For example, you can use Plot 3D Grid File, Grid File Utilities and Contour from Grid in the Civil Design module.

Finally, for users with the Ore Module that have created block models, they may be added into the PreCalc for use with the Fence Diagram and Surface Reserves commands. There is an option, next to Elevation or Attribute for Block Model. The procedure here is to build the PreCalc, interval by interval from the top down as usual. Then add in the block model for each interval, or strata that you have. It is just like the other attributes, in that it must have the same name as the strata it is referring to. There are options on the Fence Diagram and Surface Reserves screens to use the hatch fence by block model and to break out quantities by attributes.

**Pulldown Menu Location:** Drillhole
**Keyboard Command:** precalc

### Draw Fault Line

This command creates a 3D polyline that represents a fault line which is used by Fence Diagram in the intersection mode, or in the Make Strata Grid File command. When the fence line crosses the fault line, the strata will shift by the amount of the shift value of the fault line at that point. This command is very similar to Carlson Draw > 3D Polyline command, in addition to elevation for each vertex of the polyline this command prompts for fault shift. This value is the amount of elevation difference from left to right across the fault line in the direction of the line is drawn. Used is also prompted for the dip angle at the beginning, dip angle is same throughout the length of fault.
Prompts

Enter dip angle (degrees) <0.00>: 90
Reading cell > 89823
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Z: 492.29
Enter fault shift <0.00>: 35
[Arc/Distance/Close/Extend/Follow/Undo/<Pick point or point numbers>]: pick a point
Z: 481.30, Hz dist: 1408.86, Slope dist: 1408.90, Slope: -0.8% Ratio: -128.2:1
Enter fault shift <35.00>: press Enter
[arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Z: 456.90, Hz dist: 1114.75, Slope dist: 1115.02, Slope: -2.2% Ratio: -45.7:1
Enter fault shift <35.00>: 40
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Z: 456.02, Hz dist: 750.48, Slope dist: 750.48, Slope: -0.1% Ratio: -855.4:1
Enter fault shift <40.00>: 45
[arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter

Pulldown Menu Location: StrataCalc
Keyboard Command: fault

Edit Fault Line
This command is used to edit the fault line drawn using Draw Fault Line Command. It allows to edit each vertex of the fault along with its shift displacement for each vertex and the dip angle of the fault. The fault appears in the graphic window. There are buttons for pan, zoom in/out, rotate and zoom extents. Each line of the spreadsheet may be edited to update the fault line. The Pick button at the end of the row will switch to the plan view where the new location for that point can be selected. The + Add Vertex button will add a point, the X Remove Vertex will delete a point, and the Pick Location will move an existing point.
Prompts

Select fault polyline to edit: Select fault polyline
Pick new location: pick a point near vertex to be edited
Select fault polyline to edit (Enter to end):
Pick vertex to add to fault: pick a point near vertex to add
Enter Elevation <4786.99>: enter elevation of surface topography
Enter dip angle <90.0>: enter the dip of the fault
Enter fault shift (throw) <50.0>:
Pick vertex to add to fault (enter to end):
Pick new location:
Select fault polyline to edit (Enter to end): pick another fault to edit

Pull down Menu Location: StrataCalc
Keyboard Command: edit_fault
Prerequisite: fault lines drawn using Draw Fault Line

Calculate Fault Shift
This command assigns fault shifts to polylines. The polylines must be drawn ahead of time and they should follow the fault zones. After selecting the polylines to process, the program prompts for drillholes to process. Then select a strata to model. The fault shift is calculated by modeling the strata twice for each polyline. One model excludes the drillholes on the left of the polyline and the other model excludes the drillholes on the right. Then the elevation difference between the two models is used to assign the fault shifts along the polyline.

Prompts
Select fault lines.
Select objects: *pick polylines to assign fault shift to*
Select drillholes, channel samples and strata polylines.
Select objects: *pick entities to model*
Choose Strata To Process dialog

**Pulldown Menu Location:** StrataCalc  
**Keyboard Command:** calc_fault_dz  
**Prerequisite:** Polylines along the fault zones and drillholes

---

**Report Fault Lines**

This command is used to report information of each vertex of the fault lines drawn using Draw Fault Line Command.

---

**Prompts**

Select fault polylines to report:  
Select objects: *all*
8 found  
Select objects: *press Enter*

**Pull down Menu Location:** StrataCalc  
**Keyboard Command:** report_faults  
**Prerequisite:** fault lines drawn using Draw Fault Line

---

**Highlight Fault Lines**

This command is used to highlight fault lines drawn using Draw Fault Line Command.
Prompts

Select fault polylines to highlight:
Select objects: all
8 found
Select objects: press Enter

Pull down Menu Location: StrataCalc
Keyboard Command: highlight_faults
Prerequisite: fault lines drawn using Draw Fault Line

Identify Fault Polylines

This command is used to identify fault lines drawn using Draw Fault Line Command.

Prompts

Select fault polyline to identify: select a fault polyline
Vertex Strike Dip Shift Elevation
1 N 05°52'59" W 90.000 35.000 492.291
2 N 19°27'32" E 90.000 38.000 481.304
3 N 37°12'50" E 90.000 40.000 456.901
4 N 37°12'50" E 90.000 45.000 456.023

Select fault polyline to identify: press Enter

Pull down Menu Location: StrataCalc
Keyboard Command: id_faults
Prerequisite: fault lines drawn using Draw Fault Line

Apply Faults to Grid

This command is used to offset the grid values of an existing grid file. It saves a new grid file with the values offset based on the fault lines drawn with the Draw Faultline command. The Fault Influence Distance is the offset distance away from the faultlines that will be used to transition from the original grid to the faulted values.
Prompts

Fault Influence distance <500.00>: 150 Enter in distance to use.

Select fault lines:

Select objects: Specify opposite corner: 3 found Select the fault lines

Updating grid with faults 190000...

Writing grid > C:\Carlson Projects\C2 Grid with Faults.grd

Writing cell > 192240

Pull down Menu Location: StrataCalc

Keyboard Command: apply_faults

Prerequisite: fault lines drawn using Draw Fault Line and a grid file
**Draw Fault Surface**

This command draws fault surfaces as 3D faces at dip angles from fault lines drawn using Draw Fault Line Command.

![3D Viewer with fault surfaces](image)

**Prompts**

Enter vertical depth to draw fault up to: *600*
Select fault polylines to draw: *all*  
2 found
Select objects: *press Enter*

Pull down Menu Location: StrataCalc  
Keyboard Command: *draw_fault*  
Prerequisite: fault lines drawn using Draw Fault Line

**Draw Heave Zones**

This command creates closed polylines that represent the fault heave zones where the material is broken up and not mineable. These polylines can then be used as exclusion areas in routine like Strata Isopach maps to avoid contours in those areas. They can also be tagged as Strata Limit Polylines for exclusion for volumes and to delete the area in a Fence Diagram.
The command will use either an existing elevation grid file, or it will model from drillholes on screen. If there are multiple seams that are faulted, each one will have a slightly different area along the fault. Shown here is a result of drawing the heave zones. Most zones will run parallel to the faults, with the distance away from the fault based on the displacement of shift of the fault.

Prompts

Here are the prompts when using the drillholes.

Command: draw_heave_zones
Select fault polylines to process:
Select objects: Specify opposite corner: 9 found
Select drillholes, channel samples and strata polylines.
Select objects: all
101 found
Reading drillhole 101
Select the strata limit polylines or ENTER for none.
Finding splits ...
Processing only strata with beds.
Use position from another file or pick grid position [<Pick>/File]?
Pick Lower Left grid corner:
Pick Upper Right grid corner:
Weighting factor to which power [First/<Second>/Third/Other]?  P
Strata Name: V_KEY
Calculating grid by linear least squares 2601...

Pulldown Menu Location: StrataCalc
Keyboard Command: draw_heave_zones
Prerequisite: Drillholes

Create Strata Polylines at Faults
This command creates strata elevation polylines at the intersection of fault surfaces with strata models.

Prompts
Select fault polylines to process:
Select objects: all
7 found
Select objects: press Enter
Select drillholes, channel samples and strata polylines.
Select objects: all
93 found
Select objects: press Enter
Reading drillhole 93
Finding splits ...
Use position from another file or pick grid position [<Pick>/File]? P
Pick Lower Left grid corner: pick lower left corner
Pick Upper Right grid corner: pick upper right corner to include faults
Choose modeling method [ <Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq/ABOS]? I
Use inverse distance to which power [First/<Second>/Third/Other]? press Enter
Use elliptical inverse distance [Yes/No]? press Enter

Pull down Menu Location: StrataCalc
Keyboard Command: DRAW_STRATA_FAULTS
Prerequisite: fault lines drawn using Draw Fault Line and drillholes

Input-Edit Strike-Dip Symbols
This command works in an editor where the strike and dip symbols can be added, deleted or edited in a spreadsheet type editor. There are options for reporting and importing from an external text file to bring the symbols in.

- **Add Symbol (+):** This button brings up the Strike/Dip Symbol window where a new symbol can be edited. There are defaults in the window that can be modified with the data. There are options to label a description, enter the strike and dip, and symbol and text size. The symbol and text layers can be entered here, or picked from a list of layers with the Select button. The Place Symbol button allows for screen picking of the new location for the symbol.

- **Delete Symbol (X):** This button deletes the highlighted row of the selected symbol.

- **Edit Symbol:** This button is similar to the Add button, but the highlighted row symbol appears in the window, allowing for changes that are done in the drawing when the Exit is selected.

- **Report:** This option will bring up the Report Formatter where the symbols are reported. The following data can be reported, such as X, Y, Z, layer, text size, and others.
• **Import:** This option will import the symbols into the drawing from a text file of the formats shown. It is automatic if a header line is used to define the columns, it will find the names and import the data. If there isn't a header line, then each column will have to be defined prior to importing, with the dropdown arrows.

---

**Prompt**

Select all strike-dip symbols.
Select objects: Specify opposite corner: 20 found, 4 groups. (If there are no symbols in the drawing already, just hit "Enter" and the empty window will appear where new symbols can be added or imported).

**Keyboard Command:** EDIT_STRIKEDIP

**Draw Strike-Dip Symbol**

This command draws the standard strike-dip symbol based on user defined input. It has an option for entering and labeling a description. If no description is desired, then leave it blank. The strike and dip entered in the window will orientate the symbol placement. There are settings for symbol and text size, as well as layers.
Keyboard Command: struckedip

Tag Strata Polylines

This command attaches a strata name to a 3D polyline that represents the bottom elevation, top elevation or the thickness of that strata. When modeling the drillholes, each point in these strata polylines is used as an elevation or a thickness data point for the assigned strata. For example, a 3D polyline for the outcrop of a strata could be tagged with the strata name and used in processing for additional model enhancement. If bed names are used, be sure to include the _TOP, _KEY, _PARTING or _BOTTOM extensions to the bed name.

Prompts

Strata name: Seam1
Type of strata polyline [ <Elevation>/Thickness]? press Enter for Elevation
Elevation reference [ <Bottom>/Top]? press Enter for Bottom
Select strata bottom elevation polylines.
Select objects: 1 found

Pulldown Menu Location: Drillhole
Keyboard Command: stratatag
Offset Strata Polylines

This command creates additional strata elevation polylines offset by the strata thickness from a reference/starting strata polyline for elevation. This is useful for manually creating faults where all the seams are offset along the elevation strata polylines. The first prompt is to open or create an offset strata polylines file (*.OSP). The first column is the strata/bed name attached to the strata polyline. The button next to them brings up the list of defined strata. A Reference polyline is one that already exists and this is the one that will be offset from. The thickness to offset the new polylines can either be entered as a value (+/-) or as a thickness grid file. The layer is the layer that the reference polyline is on, and the layer it will draw the new polylines on. The resulting new strata polylines can be used for more accurate modeling elevations.

**Keyboard Command:** offset_strata_pl

Report Strata Polylines

This command generates a report using the Report Formatter containing all the Strata Polylines automatically found in the drawing. It reports the layer, XY of the start and end of the polyline, the tagged strata name and the type (elevation or thickness).

**Keyboard Command:** report_strata_pline
Highlight Strata Polylines

This command simply highlights the named strata polylines in the drawing. A regen of the screen will unselect the polylines.

Prompts

Select the polylines to check.
Select objects: Specify opposite corner: 5 found
Highlighted 3 Strata Polylines. Skipped 2 other polylines.
Pulldown Menu Location: Drillhole in Geology
Keyboard Command: highlight_strata_pl

Identify Strata Polylines

This command simply allows you to pick a polyline and report the strata name, if any, attached to this polyline. These are tagged for use in modeling the bottom elevation or thickness in addition to drillholes.

Prompts

Select strata polyline to identify:
Strata Name: SEAM2 Type: Thickness
Select strata polyline to identify:
Strata Name: SEAM1 Type: Elevation
Select strata polyline to identify: pick one that is not tagged
No strata name assigned to polyline.
Select strata polyline to identify:
Pulldown Menu Location: Drillhole
Keyboard Command: strataid

Untag Strata Polylines

This command removes the strata polyline information and returns the selected polylines to the original status: regular polylines.

Prompts

Select strata polylines to have strata tags removed.
Select objects: 1 found
Pulldown menu location: Drillhole
Keyboard command: stratauntag
Prerequisite: Named strata polylines

Name Limit Polylines

This command assigns strata names to identify polylines as inclusion or exclusion areas for the strata. Strata limits are used to model discontinuities such as glacier washout or volcanic strata. Strata that gradually trend to pinch out should not use strata limits. The pinch out should be modeled using just the drillholes. When assigning the names for strata in the PreCalc file, be sure they are spelled exactly the same here, so they are applied correctly. Also, when
using Limit Polylines with bed names in the drillholes, be sure to add the _TOP, _KEY, _PARTING, OR _BOTTOM to make sure the limits are applied to each bed interval.

Strata limit polylines are used in the StrataCalc routines to indicate where the strata exists. The inclusion and exclusion polylines are used for trimming the contours in Strata Isopach Maps and used to limit volumes in routines like Surface Mine Reserves. Also in areas outside the strata limits, the strata thickness is set to zero and 10000 is added to the strata elevation. This forces the strata up to clip out to the strata above. Also drillholes that are outside the strata limits are ignored for processing that strata. There is a choice to assign all strata names to the limit lines, or Specific strata. If Specific is chosen, then the following dialog appears.

When drawing a Fence Diagram and using Limit Polylines, the strata cutoff occurs exactly at limit the polylines. Shown here is an example of a Fence Diagram, plotted with the plan view for verification. Notice how the limit lines crop the seams in section view precisely at the limit lines. The plan view was placed on top of the fence diagram just with basic AutoCAD drafting tools. Dashed polylines were then drawn with ortho on to illustrate the crops honoring the limit lines exactly. For all StrataCalc routines that use limit polylines, there is a command line message to report when limit polylines are applied.
Another use of Limit Lines is to control the transition from a full seam to where it splits. Limit lines must be drawn for one or both instances. The full seam and the two split seams can both appear in the PreCalc file for volumes and Fence diagram. An example PreCalc is shown here. Notice the C2_KEY splits into C2L_KEY and C2U_KEY. They also split. All of these can exist in the PreCalc, as long as there are limit lines on screen to control where they appear.

The result is a Fence Diagram as shown here, where the limit lines control where the full seam, and its splits appear.
Prompts

Enter strata name to apply (<All>/Name)? UB for strata UB
Select Inclusion perimeter polylines.
Select objects: pick a closed polyline
Select Exclusion perimeter polylines.
Select objects: press Enter
Pulldown Menu Location: StrataCalc

Keyboard Command: minelmt

Report Limit Polylines

This command reports all Strata Limit Polylines that are in the drawing. The report contains the layers, area, XY of the polyline endpoints, and whether it is an inclusion or exclusion limit polyline.

Keyboard Command: report_strata_limit

Highlight Limit Polylines

This command simply highlights the named strata limit polylines in the drawing. A regen of the screen will unselect the polylines.

Prompts

Command: highlight_limit_pl
Select the polylines to check. (select all the polylines of interest)
Select objects: Specify opposite corner: 10 found, 2 groups, 12 total
Highlighted 2 Limit Polylines. Skipped 10 other polylines.
Pulldown Menu Location: StrataCalc in Geology
Identify Limit Polylines

This command reports the strata names assigned to a polyline for strata limits. There is the option to select one and view its name, to pick inside and have it identify which lines enclose that point, or to search the drawing and automatically highlight and report all that it finds. If the hatch option is used, then the hatch window appears where the hatch pattern can be selected for each limit polyline.

Prompts

Pick on a polyline, pick inside or search drawing [<Pick>/Inside/Search]: i
Pick inside limit polyline to identify:
Hatch Current, select Next or Exit [<Hatch>/Exit]: H to hatch
or

Pick on a polyline, pick inside or search drawing [<Pick>/Inside/Search]:
Select mining limit polyline:

Current: Inclusion: C2U C2L IB1
Hatch Current or Exit [<Hatch>/Exit]: e to exit

Pulldown Menu Location: StrataCalc in Geology
Keyboard Command: minelmtl
**UnTag Limit Polylines**

This command removes the strata limit assignments from the selected polylines.

**Prompts**

Select limit polylines to have limit data removed.

*Select objects: pick the limit polylines*

*Pulldown Menu Location: StrataCalc*

*Keyboard Command: rmlimit*

---

**Prepare Variogram Data**

This command writes out the data file for variogram as a *.DAT file. This is the input file for the Calculate Variogram command. First select the strata to process, then select the value or attribute to process.

**Prompts**
**Calculate Variogram**

This command takes the *.DAT file from Prepare Variogram and calculates the variogram data, outputting the Nugget, Sill and Range.

![Variogram Analysis](image)

**Data File:**
The data file appears in the top left corner. If the file is not displayed, chose Select, or double click in the file name window. To start it with a specific file, start it as:

`\path\Csvgram batch-\path\filename`

**Variogram Type:**
The type of variogram to calculate can is shown in the upper left corner. If the datafile has only one variable, the Covariance option in the yellow box will not be enabled. First, select the Head Variable in the yellow box, shown here as Thk m. Then select the type, such as Semivariogram. This should then display the head variables span from low to high. The current types of variograms to choose from is shown below. Details of each method can be found online.

- Semivariogram
• Cross Semivariogram
• Covariance
• Correlogram
• General Relative Semivariogram
• Parwise Relative Semivariogram
• Semivariogram of Logarithms
• Semirodogram
• Seminadogram

Variogram Attributes:

Trimming limits will provide a range selection to process. A value of 0 trimming will delete null values. Set the number of lags and lag separation distance. Lags are the number of intervals, the separation is the distance between the intervals. Normally the Lag Tolerance is Lag Separation Distance divided by 2. OmniDirectional will look in multiple circular groups for pairs. If it is off, then it will look just directional for the pairs. The number of directions, Angle Tolerance and Bandwidth apply to the directional.

Pressing Go will show the plot and show # of pairs in each lag.

Fitting:
Omnidirectional: Click Exponential option beside big circle on the right to begin. Hold down left mouse and drag on the plot to set Range, Sill and Nugget or enter them in the boxes.
Directional Trend: Select the Head Variable, the variogram plots redraw by clicking on the lines on the large directional circle so the 4 angles would be: 0 Azimuth, 135 Azimuth, 90 azimuth and 45 azimuth. The resulting values are displayed above for geostatistical modeling.

**Format:**

Data Files (standard to all Variogram analysis programs)
Line 1 title
Line 2 # of Data Variables (including X and Y)
Line 3 X Variable Name
Line 4 Y Variable Name
Lines 5 to 5+#-3 Other Variable Names
Remaining lines: X Y V1 V2 ... V(#-2)
Variables separated by spaces - pick some negative number for null
Example:
Zone A Data, Big Bean Field
8
X m meters east of origin
Y m meters north of origin
Thk m zone thickness in meters
Por % porosity in percent
Perm md permeability in millidarcies
LogPerm - base 10 log of permeability
LogPermPrd - LogPerm predicted by regression against Por
LogPermRsd - Residual from LogPerm-Por regression
12100 8300 37.1531 14.6515 2.8547 0.4556 0.1357 0.3198
5300 8700 31.4993 14.5093 -999.9999 -999.9999 -999.9999 -999.9999
3500 13900 36.9185 14.0639 -999.9999 -999.9999 -999.9999 -999.9999
5100 1900 24.0156 15.1084 1.1407 0.0572 0.2268 -0.1696
9900 13700 35.0411 13.919 -999.9999 -999.9999 -999.9999 -999.9999
2900 900 28.4249 13.1304 0.3897 -0.4093 -0.1674 -0.2419
7900 6700 33.2458 14.5724 -999.9999 -999.9999 -999.9999 -999.9999
.....

**Prompts**

Command: vgramun
Drop-Down Menu Location: StrataCalc in Geology
Keyboard Command: vgramdat

**Surface Mine Reserves**

This command calculates quantities and qualities from drillholes or predefined grid or block models. Strip ratios can also be calculated as the volume of non-key strata divided by the tons of key strata. Key strata are intended to be the target ore, and non-key strata are intended to be the overburden, interburden and parting strata. Within the drillholes or PreCalc file, each strata has a field that specifies whether the strata is key or non-key. Volumes can be stored in the pits for scheduling with this command. There are many options for reserve calculation and they are detailed in order of appearance below.
**Modeling Method:** The surface reserves can be generated on-the-fly from the selected drillholes or read from stored grid files put into a PreCalc file. The on-the-fly modeling method can be either Triangulation, Inverse Distance, Kriging, Polynomial or Linear Least Squares. An explanation of these different methods is found under Make Strata Grid Files. The Block Model option creates a BLK block model file and calculates reserves "on-the-fly". The stored grid file method is the Pre-Calculated option. The Pre-Calculated modeling method uses prepared grid files that represent the bottom elevation or thickness and quality attributes (i.e. BTU) of the strata. The grid files associated with each strata and the ground surface are set in the Define Pre-Calculated Grids command under Drillhole.

**Source of Top Surface Model...:** Surface Mine Reserves works from the top strata down to the bottom. The ground surface is modeled from either the Screen using selected surface entities, the surface grid found in the PreCalc file, a separate grid file (something different than the surface grid in the PreCalc, such as a top of bench grid) or an elevation. This elevation could be the elevation of a flat bench that represents the top of the reserve calculation interval. In the Screen method, the program builds a grid model from the selected entities (contour polylines, points and 3D entities). See the Make 3D Grid File command for a description of creating a grid file. The "Source of Top Surface Model" option sets this ground surface method. Each strata structure is modeled as the bottom elevation of that strata. The strata volume is figured by comparing the strata bottom elevation model with the previous strata. The first strata bottom elevation is compared with the ground surface grid. Each strata grid clips to the grid above so that the strata grid does not rise above the previous grid which includes the ground surface. The result is that the program will find strata outcrops if any.

**Top Elev:** When using the Elevation method in the Source of Top Surface Model, this is the elevation that controls the top of the structure or reserve block. Enter in any elevation.

**Source of Bottom Surface Model...:** Carlson can either calculate quantities straight down from the inclusion polylines ("Cookie-Cutter") or apply side slopes. There are two methods for modeling the side slopes: using a bottom surface grid or highwall slopes (explained below). Without either of these methods, the program will calculate the strata quantities straight down vertically from the inclusion perimeter. In all cases, the strata quantities are limited by the ground surface grid or elevation which effects the top strata and outcrops any other strata. The Strata Model option will calculate down to the lowest grid in the PreCalc, or the lowest grid in the Selected Strata option, if that is used. The Grid File method will go down to this grid for reserve calculations. It can have any number of benches and slopes in it. This method will prompt you for a grid file which should represent the bottom of pit surface including the side slopes. This grid file should have the same position and resolution as the surface grid. Keep in mind that the grid resolution should be small enough to...
model the pit side slopes. For example, a 100 ft grid interval would not work well for modeling side slopes that are 30 ft wide. Instead, use a grid resolution that is smaller than the side slopes width (i.e. 10 ft in this example). There are many routines for preparing the pit bottom grid including the Design Bench Pit routine and Make 3D Grid File. Typically the inclusion perimeters should start from the daylight line where the pit bottom grid intersects the surface grid. The program will calculate the strata quantities between the surface grid or elevation and the pit bottom grids. The last option is Elevation. It allows for entering an elevation to represent the base of the reserve "block". If using Elevation for the Top Surface Model, and Elevation for the Bottom Surface Model, it will calculate the various quantities within the two elevations that could represent benches. Shown below is an example of the Source of Bottom Surface Model as a Grid File.

- **Bottom Elev**: When using the Elevation method in the Source of Bottom Surface Model, this is the elevation that controls the bottom of the structure or reserve block. Enter in any elevation.
- **Use Auto-Run**: This option will prompt for the SMR auto-run file so that all of the benches, strata and elevations are predefined before hand, and all benches can be run at one time and stored in the pits for scheduling and reporting.

- **Output Elevation Grids**: Turning this option on will create grid files for the bottom of each strata found in the drillholes. Each grid needs to be named separately. The command Make Strata Grids is a better way to create these grids.
- **Output Thickness Grids**: Turning this option on will create thickness grids of the strata calculated for the current bench. It will prompt to create an overburden thickness grid, a key thickness grid and a key tons grid (tons/sq ft. or m). These grids will also be stored in the pits, if Store Results in Pits is activated. The difference is that timing using the actual numbers will average the quantities over pit area while the grids will model the thickness within the pit so that timing through a shallow end of the pit will be faster than the deep end. Within Output Thickness Grids, there is an option to divide the bench by thickness. This option will split the non-key volume at the specified thickness into two benches. For example, if you have 50 feet of overburden and one piece of equipment will remove the first 10 feet while a second removes the rest, then set the divide value at 10 feet and it will divide the first overburden into two benches.
- **Use Surface History**: This option will use the series of grids stored in a grid sequence file (.GSQ) for bench volume calculations. The first grid in the file is used as the starting surface grid and the second grid is used as the bottom grid. The program calculates the strata quantities and qualities using these two grids. Then the program repeats this time using the second grid as the surface grid and the third grid as the bottom grid. Again the strata values are calculated using the next two grids. This process repeats until the last pair of grids in the sequence file. The purpose of this routine is to calculate the strata values at different mining stages or benches. These benches are reported separately in the final report. One routine that prepares the grid sequence file is Design Bench Pit. If the Store Results in Pits is selected, these benches are automatically assigned to the pits for timing.
- **Merge Bench Quantities Percent**: This option is active when using the Surface History File. If there are quantities less than the entered tolerance percent, then they are merged into the associated bench. This
eliminates the error where a grid cell is crossing over from one bench to another.

- **Use Highwall Slopes:** This method applies the side slopes on-the-fly. The slopes to use are specified under the Set Slopes button. In this method, the inclusion perimeters should go around the base of the pit. The program will apply the side slopes from the inclusion perimeter up to the surface starting at the elevation of the bottom strata. The daylight perimeter and any bench lines are drawn as 3D polylines. This will only use depths up from the bottom for changing slope, and is used when just reserving for one total bench. If more complex benching is needed, then the Use Surface History is the preferred method, created with Design Bench Pit.

- **Set Slopes:** When using the Highwall Slopes option, this button brings up the Highwall Slopes dialog. Slope can be entered in as Percent or Ratio. The Smooth Slope Transitions is "all or nothing". Using the slopes shown, if the depth was 60, then the entire slope would be 1.5:1. The Slopes in Series option is more for benching. Using the slopes shown below, 0-50 will always be 1:1. Once the depth gets above 50, it will switch to a 1.5:1 and so on. Using Slopes in Series will allow for Repeat Slopes, until it gets up to the surface. There are only 5 different rows available to enter in the slope template.

![Highwall Slopes Dialog](image)

- **Use Drillhole Elevations in Surface:** This option only applies if one of the modeling methods are chosen and not Pre-Calculated. The drillhole surface elevations should be used if they enhance the surface topo, but if they differ from the surface contours or points, then they should not be used.

- **Ignore Zero Elevations:** This option only applies when using the entities on screen to create the surface. Unless the mine is down near sea-level, zero elevations should normally be ignored.

- **Use Triangulation Subdivision:** This option only applies to the modeling methods of Triangulation and Polynomial. It subdivides the triangles to create smoother surfaces and ensure that contours do not cross.

- **Use Global Trend Extrapolation:** This also applies only to Triangulation and Polynomial. This option finds the average slope and direction of the existing data and applies this slope to extrapolating where there is not surface data.

- **Recovery Percent:** This window defines the percentage of Key strata volume that was recovered in mining and to include in the volume and strip ratio reporting. The non-recovered key strata is added to the NonKey volume. The recovery percent in the Surface Mine Reserves dialog applies to all the Key strata. Enter in as 100 or 95.4 or 92, etc.

- **Use Strata Definitions (for Recovery):** To have different recoveries for each Key strata, use Define Strata to create a strata definition for each Key strata with the appropriate recovery percent. Then run Surface Mine Reserves and click on Use Strata Definitions.

- **Use Attribute (for Recovery):** Another recovery method is to have a strata attribute for recovery. This allows for different recovery percents at different drillholes. Then the recovery is modeled for the area. The name of the recovery attribute is specified in the dialog. This attribute will need to appear in the drillholes for modeling on the fly, or in the PreCalc as a strata attribute, with the name spelled as it appears in the Name window to the right.
• **Name (Attribute):** This is the name of the recovery attribute that will be referenced when using the Use Attribute option for recovery percentage.

• **Min Key Thickness To Use:** This option adds key strata to the nonkey strata above, in areas that have thickness less than the specified minimum thickness. Also areas with thickness less than the minimum are not counted in the reported strata area.

• **Use Density Attribute:** The strata density can be defined at different levels from general to specific and the program will use the most specific density that is found for the strata. The most general density setting comes from the current drillhole definition file (.ch) as set with the Define Drillhole command. The next level is the density setting that is stored in each drillhole. To check a drillhole density, use the Edit Drillhole command, the Key density is displayed in the bottom of the dialog. The next level is strata specific density that can be assigned with the Define Strata command. The most specific level of density definition is the "Use Density Attribute" option shown here in Surface Mine Reserves. This option models the strata density using the strata attribute with the user-specified name for density (i.e., "Density"). Not only does this method use the modeled strata density when averaging the strata quantities with other strata, but the modeled density is used within the strata to weight average that strata qualities. For example, if the strata is more dense in one area, then the qualities such as BTU in this area will be weighted more heavily. This can be changed if desired, under Attribute Options in the Report Formatter.

• **Name (Density):** This is the name of the Density attribute that will be referenced when using the Use Density Attribute option for recovery percentage. This must be spelled exactly as it appears in the drillholes or PreCalc file.

• **Min Minable Parting Thickness:** This setting will add the non-key parting quantities with the key quantities when the non-key parting thickness is less than the specified amount. For example, if the Min Minable Parting is set to 0.5, then a non-key strata between two key strata would be combined with the key in areas where the non-key thickness is less than 0.5 feet. In areas where the thickness is greater than 0.5, the non-key quantities are not adjusted. Combining the non-key quantities to the key will add to the total key tons and affect the strip ratio. If the non-key strata has qualities (i.e., ASH, Sulfur), then these non-key qualities will be composited by nonkey tons with the key tons for the portion of non-key that is less than the minimum parting. This will dilute the key qualities.

• **Min Depth To Use:** The Minimum Depth to Use option adds key strata to the overburden in areas that have depth less than the specified minimum depth. For example, if any Key strata are closer than 10 feet to the surface, then they can be considered "weathered" and reported with the NonKey waste material.

• **Which Strata To Include...:** This determines what will be calculated for the reserve. If All is chosen, then all strata in the drillholes or PreCalc file will be calculated and reported. If Selected is chosen, then the next window to appear is where one or multiple strata can be selected. This can be used for multiple reserve runs, selecting different strata to represent each bench.

• **Skip Running Totals:** This option skips the running total quantities and strip ratios for the strata. If it is not selected, then the total for each pit is added to the next for a "running total" quantity. If it is checked, then the pits are totaled separately, and with a grand total at the end of the report.

• **One Row Per Strata:**

• **All Strata on Same Row:** This option puts all the strata quantities and qualities for each pit polyline on one row. This format is best suited for only a few strata and for printing landscape on a page. If it is not selected, then each strata will appear on a separate row.

• **Group Key/NonKey Pairs:**

• **Calculate Strata Qualities:** This toggle will report the average qualities for strata attributes such as BTU and sulfur. Otherwise the program skips calculating qualities to save time. Besides reporting the qualities for each strata individually, the program can also report the total averaged qualities. By default, the qualities are weight averaged by tons which are calculated by using the strata volume and density.

• **Breakout Quantities By Attributes:** This feature works in conjunction with the Block Modeling and Grade Parameter file. Once the BLK file has been created, and the grade parameter file defined, they are used in this reserve routine to calculate the volume of material falling in certain ranges. For example, Surface Reserves will report tons of ore with calcium of 80-90, tons of ore with calcium 90-100, etc.

• **Fixed Non-Key Qualities:** This option will prompt to enter one value for each strata quality found in the drillholes or PreCalc to use for all non-key strata. This option is useful in the case for calculating the composite
key strata qualities when there is key strata dilution from non-key strata due to Min Minable Parting. Prompts will look like:
Non-Key value for BTU: 1000
Non-Key value for MOIST: 35
Non-Key value for SUL: 7
Non-Key value for ASH: 50
Non-Key value for DENSITY <80.00>: 155

- **Use Named Pit Areas:** The area for calculating quantities defaults to the limits of the selected surface entities and drillholes if no inclusion perimeters are selected. To control the calculation area, multiple closed polylines for areas to include and/or exclude can be selected. An unnamed pit polyline will limit the area of calculations. Also, areas can be labeled with site and pit names (i.e. Site 1, Pits 101, 102, ...). Surface Mine Reserves will then calculate the strip ratios and volumes for each site and pit area. To use site and pit names, there are several commands for creating named pit polylines in the Boundary menu of Surface Mining. If this is selected, then it will look just for named pit polylines, ignoring anything else.
- **Store Results In Pits:** This option is available when named pit polylines are used. This option will store the total non-key volume, key volume and key tons and all quality attributes for each pit polyline as extended entity data to the pit polylines. These quantities can then be used by the Surface Equipment Timing command. Besides the quantity and quality values, a Bench number is also stored with the quantities for sequencing each bench. For example, if you have two key and nonkey seams that you are going to mine in two passes, then use the Which Strata to Include: Selected option and choose the first pair of NonKey/Key strata with the Bench# set to 1. Then run Surface Mine Reserves a second time with the second pair of NonKey/Key strata and the Bench# set to 2. The quantities calculated can be stored either as values or as thickness grids for scheduling. The grid option is activated by the Output Thickness Grids option, otherwise it will store the values in the pits. The difference is that timing using the actual numbers will average the quantities over pit area while the grids will model the thickness within the pit so that timing through a shallow end of the pit will be faster than the deep end. Within Output Thickness Grids, there is an option to divide the bench by thickness. This option will split the non-key volume at the specified thickness into two benches. For example, if you have 50 feet of overburden and one piece of equipment will remove the first 10 feet while a second removes the rest, then set the divide value at 10 feet and it will divide the first overburden into two benches.
- **Bench#:** Enter in the Bench number to assign for this "run" of Surface Reserves. Usually Selected Strata is used with this, to select the strata to assign for each bench number reserve run.
- **Use Property Boundaries:** Property boundaries can be used to break up the reserve by owner and property. The commands for laying out property boundaries are in the Boundary menu. Essentially, property boundaries are closed polylines with owner and property ID names. The property polylines do not need to be clipped with the calculation inclusion perimeter or pit polylines. The program will internally clip the properties with the calculation areas and report the amounts by property within each pit area. If a pit or inclusion polyline is not covered by a property, the property name used for these quantities is "unknown". To activate property boundaries, click on the Use Property Boundaries toggle and the program will search and find them automatically.
- **Use Reserve Classification:** Using this option will prompt for an RSV file created with the separate command Reserve Classification under Grids in the Geology Module. This will separate the reserve into Measured, Indicated, Inferred and Hypothetical, based on what is entered in the RSV file.
- **Output Spoil File:** This option gives the option to create a spoil file. There are 3 options, Off, Nonkey Only and All Strata. Normally, the spoil would include just the Nonkey waste material. This creates a spoil placement file (*.SPO) that is used for the timing of the spoil routines under the Spoil Menu of Surface Mining.
- **Strip Ratio Output:** The Draw Contours option will contour the total strip ratios of all the processed strata (NonKey volume : Key tons). The program will create the contours from a grid file of the calculated strip ratio values. If you just want the grid file and not the contours, choose the Grid File toggle and the program will prompt for a grid file name to create.
- **Type of Strip Ratio Output:** There are two methods for making the strip ratio grid and contours. The
Instantaneous option will calculate the strip ratio using the strata thicknesses of the vertical strata column at each grid corner. The Accumulative method will start with the lowest strip ratio in the calculation area and keep adding the next best strip ratio areas, basically an accumulative strip ratio of the selected areas of the mine site. The grid file is assigned the running strip ratio as the program adds these areas.

- **Non-Key Thickness To Add To Key: Above Key/Below Key:** These fields allow you to specify the amount of non-key thickness above and/or below the key strata that will be combined with the key (roof and floor dilution) This amount will be taken from the non-key quantities and added to the key. Similar to the Min Minable Parting Thickness, the non-key quantities will increase the total key tons which affects the strip ratio and key volume mined. Also any non-key strata qualities will be combined by thickness, weighted by NonKey density, and added to the key which dilutes the key qualities. For example, if you estimate that 0.25 feet on average of the overburden is taken with the coal, then you could set the Non-Key to Add to Key for Above to 0.25.

The Report Formatter Options dialog is the final step of the Surface Reserves routine. It is documented elsewhere in the Help manual for more details on its operation.

![Report Formatter Options dialog](image)

**Prompts**

**Surface Mine Reserves dialog**

Select surface entities and at least 3 drillholes. (Unless using a PreCalculated Grids File PRE.)

Select objects: select the drillhole symbols and surface entities. Surface entities can include points, lines, and polylines.

Select the Inclusion perimeter polylines and ENTER for none:
Select objects: select the polylines or named pit polylines. The area within these polylines will be included in the calculations. They must be closed polylines.

Select the Exclusion perimeter polylines and ENTER for none:
Select objects: select the polylines. The area within these polylines will be excluded from the calculations. They must be closed polylines.

Make Grid File Set grid resolution
Triangulating points ... 49
Pass > 6 NULL Z values left > 0
Processing cell 2500 ...
Finished strata Y2
The above four steps are repeated for each strata.

Report Formatter

Pulldown Menu Location: StrataCalc or Reserves/Timing
Keyboard Command: mnttop

Define Surface Mine Auto Run

This command is the setup routine to create the autorun file for batch processing of multiple benches with one run of the Surface Mine Reserves command. Without this predefined autorun file, then the Surface Mine Reserves command needs to be run separately for each bench. With this Autorun file, all benches are predefined by the PreCalc file, a top and bottom Grid or TIN, or an Elevation.

The steps necessary to create or edit the file are detailed below. Choosing Add or Edit will bring up the Edit Auto-Run window. This is where the Bench# is set. The Strata to Process can either be set to one, multiple, or all to define the benches. If coming out of the PreCalc file, then the elevation grids defined in there will define the benches here. Alternately, the benches can be other grid or TIN surfaces, or flat elevations, and they will be intersected by the seams that appear in the PreCalculated grids file.

To utilize this Autorun file, turn on the option in the Surface Mine Reserves window for "Use Auto-Run" as circled below. Once this is on, the program will prompt to select the *.SMA file this command created.

Pull down Menu Location: StrataCalc
Keyboard Command: mnttop_autorun
Prerequisite: Grids and PRE Calculated Grids file, named pits
Underground Mine Reserves

This command calculates quantities and qualities from drillholes or predefined grid or block models. Key strata are intended to be the target ore, and non-key strata are intended to be the overburden, interburden and parting strata. Within the drillholes or PreCalc file, each strata has a field that specifies whether the strata is key or non-key. There are many options for reserve calculation and they are detailed in order of appearance below.

- **Modeling Method:** The reserves can be generated on-the-fly from the selected drillholes or read from stored grid files put into a PreCalc file. The on-the-fly modeling method can be either Triangulation, Inverse Distance, Kriging, Polynomial or Linear Least Squares. An explanation of these different methods is found under Make Strata Grid Files. The stored grid file method is the Pre-Calculated option. The Pre-Calculated modeling method uses prepared grid files that represent the bottom elevation or thickness and quality attributes (i.e. BTU) of the strata. The grid files associated with each strata and the ground surface are set in the Define Pre-Calculated Grids command under Drillhole.

- **Use Triangulation Subdivision:** This option only applies to the modeling methods of Triangulation and Polynomial. It subdivides the triangles to create smoother surfaces and ensure that contours do not cross.

- **Use Global Trend Extrapolation:** This also applies only to Triangulation and Polynomial. This option finds the average slope and direction of the existing data and applies this slope to extrapolating where there is not surface data.

- **Make Thickness Grids:** Turning this option on will create thickness grids of the selected or all strata. It will prompt to create an overburden thickness grid, a key thickness grid and a key tons grid (tons/sq ft. or m).

- **Output Grids for Each Strata:** Turning this option on will create grid files for the bottom of each strata found in the drillholes. Each grid needs to be named separately. The command Make Strata Grids is a better way to create these grids.

- **Report Areas On One Row:** This option puts all the strata quantities and qualities for each inclusion polyline on one row. This format is best suited for only a few strata and for printing landscape on a page. If it is not selected, then each strata will appear on a separate row.

- **Use Property Boundaries:** Property boundaries can be used to break up the reserve by owner and property. The commands for laying out property boundaries are in the Boundary menu. Essentially, property boundaries are closed polylines with owner and property ID names. The property polylines do not need to be clipped with the calculation inclusion perimeter or pit polylines. The program will internally clip the properties.
with the calculation areas and report the amounts by property within each pit area. If a pit or inclusion polyline is not covered by a property, the property name used for these quantities is "unknown". To activate property boundaries, click on the Use Property Boundaries toggle and the program will search and find them automatically.

- **Calculate Strata Qualities**: This toggle will report the average qualities for strata attributes such as BTU and sulfur. Otherwise the program skips calculating qualities to save time. Besides reporting the qualities for each strata individually, the program can also report the total averaged qualities. By default, the qualities are weight averaged by tons which are calculated by using the strata volume and density.

- **Recovery Percent**: This window defines the percentage of Key strata volume that was recovered in mining and to include in the volume and strip ratio reporting. The non-recovered key strata is added to the NonKey volume. The recovery percent in the Reserves dialog applies to all the Key strata. Enter in as 100 or 95.4 or 92, etc.

- **Use Strata Definitions (for Recovery)**: To have different recoveries for each Key strata, use Define Strata to create a strata definition for each Key strata with the appropriate recovery percent. Then run Surface Mine Reserves and click on Use Strata Definitions.

- **Use Attribute (for Recovery)**: Another recovery method is to have a strata attribute for recovery. This allows for different recovery percents at different drillholes. Then the recovery is modeled for the area. The name of the recovery attribute is specified in the dialog. This attribute will need to appear in the drillholes for modeling on the fly, or in the PreCalc as a strata attribute, with the name spelled as it appears in the Name window to the right.

- **Name (Attribute)**: This is the name of the recovery attribute that will be referenced when using the Use Attribute option for recovery percentage.

- **Min Key Thickness To Use**: This option adds key strata to the nonkey strata above, in areas that have thickness less than the specified minimum thickness. Also areas with thickness less than the minimum are not counted in the reported strata area.

- **Min Minable Parting Thickness**: This setting will add the non-key parting quantities with the key quantities when the non-key parting thickness is less than the specified amount. For example, if the Min Minable Parting is set to 0.5, then a non-key strata between two key strata would be combined with the key in areas where the non-key thickness is less than 0.5 feet. In areas where the thickness is greater than 0.5, the non-key quantities are not adjusted. Combining the non-key quantities to the key will add to the total key tons and affect the strip ratio. If the non-key strata has qualities (i.e. ASH, Sulfur), then these non-key qualities will be composited by nonkey tons with the key tons for the portion of non-key that is less than the minimum parting. This will dilute the key qualities.

- **Non-Key Thickness To Add To Key: Above Key/Below Key**: These fields allow you to specify the amount of non-key thickness above and/or below the key strata that will be combined with the key (roof and floor dilution) This amount will be taken from the non-key quantities and added to the key. Similar to the Min Minable Parting Thickness, the non-key quantities will increase the total key tons which affects the strip ratio and key volume mined. Also any non-key strata qualities will be combined by thickness, weighted by NonKey density, and added to the key which dilutes the key qualities. For example, if you estimate that 0.25 feet on average of the overburden is taken with the coal, then you could set the Non-Key to Add to Key for Above to 0.25.

- **Which Strata To Include...**: This determines what will be calculated for the reserve. If All is chosen, then all strata in the drillholes or PreCalc file will be calculated and reported. If Selected is chosen, then the next window to appear is where one or multiple strata can be selected. This can be used for multiple reserve runs, selecting different strata to represent each bench.

- **Use Named Pit Areas**: The area for calculating quantities defaults to the limits of the selected surface entities and drillholes if no inclusion perimeters are selected. To control the calculation area, multiple closed polylines for areas to include and/or exclude can be selected. An unnamed pit polyline will limit the area of calculations. Also, areas can be labeled with site and pit names (i.e. Site 1, Pits 101, 102, ...). Surface Mine Reserves will then calculate the strip ratios and volumes for each site and pit area. To use site and pit names, there are several commands for creating named pit polylines in the Boundary menu of Underground Mining. If this is selected, then it will look just for named pit polylines, ignoring anything else. The Specify Names button will name the polylines from inside this command if they are not already named using commands found under Boundary.
The Report Formatter Options dialog is the final step of the Underground Reserves routine. It is documented elsewhere in the manual for more details on its operation.

### Prompts

**Underground Mine Reserves dialog**
Select surface entities and at least 3 drillholes. (Unless using a PreCalc.)
Select objects: *select the drillhole symbols and surface entities* Surface entities can include points, lines, and polylines.
Select the Inclusion perimeter polylines and ENTER for none:
Select objects: *select the polylines or named pit polylines* The area within these polylines will be included in the calculations. They must be closed polylines.
Select the Exclusion perimeter polylines and ENTER for none:
Select objects: *select the polylines* The area within these polylines will be excluded from the calculations. They must be closed polylines.

**Make Grid File** Set grid resolution
Triangulating points ... 49
Pass > 6 NULL Z values left > 0
Processing cell 2500 ...
Finished strata Y2
The above four steps are repeated for each strata.

**Report Formatter**

**Pulldown Menu Location:** StrataCalc in Advanced Mining
**Keyboard Command:** reserves

**Make 3D Grid File**
This command is described in the Civil Design section of the Manual. Please refer to it there.
**Make Top Of Key Grid**

This command analyzes the thicknesses of the Key strata in a PreCalc file and creates a new base of overburden grid based on a minable key thickness entered. It starts at the top Key strata. Anywhere the thickness is less than the value entered, the grid drops down to the to off the next Key strata. This grid can then be added to a mining model PreCalc file for calculating overburden volumes and for scheduling. Shown below is a cross section example of the grid dropping down when the key thickness falls below the entered thickness value.

![Cross Section Example](image)

**Prompts**

Minimum key thickness <0.0>: 1  
Reading cell> 194032  
Reading cell> 194032  
Reading cell> 194032  
Writing grid> c:\scad2005\DATA\New Top of Key.grd  
Writing cell> 194032  
Done.

Pulldown Menu Location: StrataCalc  
Keyboard Command: top_key

**Make Nearest Data Point Grid**

This command creates a distance grid file where the value of each grid corner is set to the distance to the nearest data point in a drillhole. This is useful to see the distance between drillholes when planning additional drilling. The grid can be contoured, as shown below, for better analyzing. The grid dimensions are set first, then two dialogs appear to select the strata to grid, and the attribute to grid.
Prompts

Pick Lower Left limit of surface area <1.45355e+006,1.96843e+006>:
Pick Upper Right limit of surface area <1.46712e+006,1.97763e+006>:
Ignore zero values [<Yes>/No]? N
Select drillholes, channel samples and strata polylines.
Select objects: all
129 found
Select objects:
Reading drillhole 129
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Writing grid file C: DRAWINGS \ GRIDS \ Nearest Data Points.grd ...
Pulldown Menu Location: StrataCalc
Keyboard Command: distgrid

Grid Inspector

This command reports and labels the value of grids at user-specified points. Up to nine grids can be analyzed at a time. After loading the grids, the program will display each grid value at the current cursor position in real-time as you move the cursor. The values are displayed in a pop-up window that appears in the top left corner, but can be moved around.

The grids to inspect are specified in the dialog shown below. You can either type in the grid file name or pick the Select File button to choose the grid file. To remove a grid from processing, erase the grid file name or pick the Clear button to remove all the grids from the dialog. The Load Pre-Calc button lets you select grid files from the list of grids stored in a Pre-Calculated file (.pre). The Name field is used for labeling the grid values. It will default to the grid name, but may be edited.
When you pick a point or enter coordinates, the program will label the grid values and draw a symbol at the point. The Select Symbols option will prompt you to select symbols from the drawing and the program will label the grid values at each symbol position. For example, you can use this option to quickly label the grid values at each drillhole symbol.

Prompts

Select Symbols/<Enter or pick point>: pick a point
Select Symbols/<Enter or pick point>: press Enter

Pulldown Menu Location: StrataCalc
Keyboard Command: grdvals

Grid History Review

This command will report information on the creation and history of grid files (.GRD) in the selected directory. Such parameters as modeling methods and settings, time and date, grid cell dimensions, file size and even which drillholes used with their values are reported.
There are no prompts in this routine, only three dialog windows that guide you through this informative command. The first window is where you select the directory containing the grids to analyze. Simply highlight that directory and select OK. The program will read all of the grids in that directory and present them in the Grid History Review window. If there are many grids, this might take a minute or two.

The list of grids shown is sorted alphabetically and displays the name, size, time and date, cell size and modeling method for creation. If the grid was made in a version of SurvCADD from CES (this version is from around 1999) and before, then all the information will show "UNKNOWN".

Highlight a grid and selecting the info button will bring up the report window showing yet more information of the highlighted grid. This is where the method and settings, strata, and drillholes with their names, locations and values are reported. The report may be edited here, saved to a file, sent to the printer or placed on screen as AutoCAD text.
Pulldown Menu Location: StrataCalc
Keyboard Command: grdreview

Draw 3D Grid File
This command is described in the Civil Design section of the Carlson Manual. Please refer to it there.

Contour From Grid File
This command is described in the Civil Design section of the manual. Please refer to it there.

One Surface Volumes
This command is described in the Civil Design section of the manual. Please refer to it there.

Two Surface Volumes
This command is described in the Civil Design section of the manual. Please refer to it there.

Grid File Utilities
This command is described in the Civil Design section of the manual. Please refer to it there.

Merge Grid Files
This command is described in the Civil Design section of the manual. Please refer to it there.

Merge Elevation for Zero Thickness
This command merges two elevation grid files and outputs the result to a new grid file. The purpose of this command is to "pancake" together the top and bottom elevation grids for a strata so that the thickness is zero in specified areas. The two input elevation grid files should have the same grid position and resolution. One represents the top of strata elevation and the other represents the bottom elevation. The output grid will have the top grid elevations except in areas of zero thickness where the output grid will have the bottom grid elevations. This output grid can then be used as the new modified top elevation grid. StrataCalc routines will have the same elevation for the top and bottom of the strata in the areas of zero thickness.

After prompting for the grid file names, the program prompts for the inclusion and exclusion polylines. These should be closed polylines where everything inside the inclusion polylines and outside the exclusion polylines has
zero thickness. For example, you can draw a closed polyline for an inclusion area around an area where the strata pinched out, where you want it to be zero, or has already been mined.

Prompts

Select TOP Elevation Grid File dialog
Select BOTTOM Elevation Grid File dialog
Specify New Elevation Grid File dialog
Specify inclusion and exclusion areas for zero thickness.
Select the Inclusion perimeter polylines or ENTER for none:
Select objects: select a closed polyline
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter

Pulldown Menu Location: StrataCalc
Keyboard Command: mergegrd2

Cleanup Grid Area

This routine takes a grid file and a closed 3D polyline, and combines the two. The elevations of the closed polyline are assigned to the grid elevations. Then the polyline is modeled and the resulting surface is applied to the original grid inside the polyline area. The resulting grid is then saved to a new grid file.

Prompts

Select a perimeter polyline:
Reading cell > 12604
Adding intersections with grid to polyline...
Assigning elevations...
Triangulating...
Setting new grid elevations...
Reading cell > 12604

Pulldown Menu Location: StrataCalc
Keyboard Command: cleanupgrid

Reserve Classification

This command is a one step reserve classification analysis. The purpose of the analysis is to estimate quantities and qualities of the mine reserve, dividing it into various zones based on the distance to the closest drillhole. The reserve estimation is less reliable when the closest drillhole is farther away. Typically the following zones are defined by the following distances:

Measured <1320ft
Indicated >1320ft, <3960ft
Inferred >3960ft, <15840ft
Hypothetical >15840ft

The first prompt is to create a new, or select an existing Reserve Classification file *.RSV.
The next step is to define a strata name to search for in the drillholes selected along with the quality name and name of the grid file to use. The program processes each line in the list, taking into account only drillholes which have strata specified and calculating from the grid quality values for each zone.

**Strata:** This window is to choose a strata or bed name that appears in the drillholes to classify.

**Quality:** This is the quality attribute to analyze, such as thickness, BTU, Calcium, etc.

**Grid:** This is the grid name that has been created from the drillholes. It will compare these modeled values with the occurrences and spacing in the drilling.

**Match Both Strata and Quality:** This will make sure that the quality and strata name both are defined in a drillhole. If just the strata name is there, but no quality sample, then it will not be used as a sample point that is measured.

**Inc/Excl Layer:** These are the layers that the perimeters are drawn in.

**Result Layer Prefix:** This is a prefix it will put in front of the output layer names.

**Draw Polylines:** This will draw the perimeter polylines that contain the hatching for the four classifications.
**Draw Hatch:** This will draw the hatching inside the perimeters and boundaries of classifications.

**Skip Report:** This option just does the CAD graphics and mapping only, not generating the report.

**Assign Pit Names:** This option will give a Pit Name to each perimeter, so it may be used for other volume calculations with commands such as Surface Mine Reserves.

The command uses property lines, or at the least, an inclusion polyline, to define the extent of the area of reserve. Nothing will be calculated if there is no property line or standard inclusion perimeter selected, and the following error will appear.

![Error Message](image)

The owner name associated with the property line will also be reported, making estimation of royalties an easy task. Optionally, the inclusion perimeter may be specified to limit area of calculations.

The results are shown as colored maps layerized by the chosen quality, with color changing based on the corresponding reserve class.

![Map Example](image)

**Prompts**

- **Select Reserve File dialog**
- **Reserve Classification dialog**
- **Select Drillholes to process:** *select drillholes to use in calculations*
- **Select Inclusion polyline:**
- **Report Formatter Dialog**
- **Pulldown Menu Location:** StrataCalc
Keyboard Command: reserve_class

Convert As Determined Qualities
This function calculates strata qualities "as delivered" based on in place qualities. A Pre-calculated grid file with all strata and quality grids specified is required to run the command.

The dialog below shows a typical use of the routine. The strata list displays all the strata defined in the pre-calculated grid file. To calculate "as delivered" qualities of the particular strata pick that strata from the list. Then fill out at least the Moisture field by picking the corresponding quality name from the list or by specifying a value if grid is not present. This allows the program to calculate dry qualities by picking a quality in pull-downs in the lower left corner and specifying an output grid file name in the corresponding dry grid line.

When Ash and BTU fields are filled out, dry Ash, dry BTU and BTU(MAF) grids may also be calculated.

Repeat this procedure for every strata in the list for which dry qualities are to be calculated by the routine. When finished click on the OK button and all the required grids will be generated.

Prompts
Select Pre-Calculated Grids File Dialog
Select a file for Proximate Analysis (the .DIL File Dialog)
Pulldown Menu Location: StrataCalc
Keyboard Command: dilute1

Composite Qualities Analysis
This function calculates quality grids for user-defined composite strata. A Pre-calculated grids file with all strata and quality grids specified is required to run the command.
First you should define a composite strata by specifying which strata it is made of and amounts of strata included in the composite. The amounts are either specified as % of or thickness of the seam. Then specify a quality to weight the other qualities by, picking from the list on the top. Below it define all the qualities to be calculated along with the corresponding output file names. Click on the OK button when done filling in all the information and the grids specified will be calculated.

### Prompts

- **Select Pre-Calculated Grids File Dialog**
- **Select .AVG File Dialog**
- **Pulldown Menu Location:** StrataCalc
- **Keyboard Command:** dilute2

### Blending Weighted Average

This command creates calculates the weighted average for qualities resulting from mixing different materials together. The names of the qualities are user-defined. Up to four weighted qualities can be calculated at once. The quality names are specified in the first row of boxes. For each type of ore to include in the mix, fill out the row as shown below including the name, tons and value for each quality. The name is used in the report. The weighted average is based on the tons of each value. The report is presented in the standard report viewer which can print, file or draw the report.
Calculate Residuals

This command measures the accuracy of the strata grid model based on the residual at each drillhole data point. The residual is calculated by removing the data point and then comparing the grid model calculation at the point with the actual value. Residuals for any strata data value such as thickness, elevation or BTU can be calculated using any modeling method including triangulation, polynomial, Kriging, least squares and inverse distance.

Consider calculating residuals for thickness with five drillholes. For each drillhole, the drillhole is temporarily removed from the model and the thickness calculated at the drillhole position. For example, one drillhole could have a thickness of 5.0. When this drillhole is removed and the four remaining drillhole using inverse distance calculate the thickness at this point, the modeled value could be 5.25. The difference of 0.25 between the actual value 5.0 and
the modeled value 5.25, is the residual.

The first dialog to appear contains some settings on the residual analysis.

- Ignore Zero Data Values: This will ignore any values of 0 that are found in the drillhole. They could be thickness, elevation or any quality attributes. Sometimes they should not be ignored, depending on what is being modeled.
- Use Report Formatter: Turn this option on to see the report with the Report Formatter. If it is off, then the standard report viewer is used.
- Calculate Histogram: The Histogram is a statistical graph of the distribution of a dataset. It shows the number of data samples within a series of value ranges.
- Number of Histogram Bins: The user can set the number of bins for the graph. For example, if a dataset of sulfur has values from 1.0 to 4.0 and the user asks for 3 bins, then the histogram will show the number of samples between 1.0 to 2.0, between 2.0 to 3.0 and between 3.0 to 4.0.
- Mark Outliers: The Mark Outliers option highlights data points that are more than 2 standard deviations from the data set average. This can be useful for flagging possible problem data points.
- Mark Layer: This is the layer of the circle mark drawn around the outlier drillholes.
- Mark Size: This is the size of the mark, or circle drawn around the outlier drillholes.

Chapter 14. Geology Module
For triangulation and polynomial, the residual is not calculated for some points because removing these points shrinks the triangulation area and the point may fall outside the area. Also you need more than three points to calculate residuals with triangulation and polynomial methods.

**Prompts**

Select drillholes, channel samples and strata polylines.
Select objects: Specify opposite corner: 269 found
Select objects:
Reading drillhole 269
Choose modeling method [Triangulation/Inverse dist/Kriging/Polynomial/LeastSq/ABOS]?
Use inverse distance to which power [First/Second/Third/Other]?
Use elliptical inverse distance [Yes/No]?
Calculating grid by inverse distances 4...
Try another modeling method (Yes/No)? No
Calculate BOTTOM ELEVATION residuals for strata 9 (Yes/No)? No
AutoRun Residuals

This command automates running the Calculate Residuals command. For this command, you set up a list of strata names, values and modeling methods. Then all these methods can be run and the results displayed in a formatted report.

This command starts by prompting for the drillholes to process. The list of available strata comes from these selected drillholes. Then a dialog is displayed that has function keys and shows a list of the methods. Use the Add button to append an entry to the list. The Add routine will bring up a dialog for entering a strata name, value and modeling method. To edit an entry in the list, highlight the entry and pick the Edit button.

The Move Up/Down buttons change the order of the selected entry. The Sort button will sort the list by strata name. The On/Off buttons change the processing status of the highlighted entry. The Auto-Run Residuals list can be saved to a file with a .RES extension. The Use Report Formatter option will activate the report formatter for choosing which fields to report. Otherwise the report is in the same format as the Calculate Residuals command. The Summary Report Only option will report only the strata name, method, and overall statistics. Turn this option on or off.
off to get a report of the residuals at each point. Pick the **Calc Residuals** button to process the list. For more description on the various modeling methods, go to Make Strata Grids where they are described.

### Pulldown Menu Location: StrataCalc

**Keyboard Command:** autostat

### Fence Diagram

Fence Diagram produces a profile of the surface and strata along the selected baseline polyline—a geological cross-section. This command is somewhat similar to the command Profile from Surface Model. Fence diagrams are a good way to verify that the geological model is correct—especially when the drillholes are plotted on them with Draw Geologic Column option. The first step is to draw a baseline polyline in plan view from which the fence diagram is created. This polyline can have more than two points and can either go to drillholes or between them. The Fence Diagram can either be drawn on a 2D grid off to the side, or in 3D, and rotated around in 3D. Fence Diagram derives the strata profiles by either gridding, a Precalculated Grids file, or intersection method. There are many options for scale, hatching and labeling. They are explained separately below.
**Draw Fence Diagram: In Real World Coordinates or On a 2-D Grid:** There are two options for choosing the location of the fence diagram. It can be drawn in real world coordinates in 3D, directly below the fence line drawn in plan view. It will have to be rotated on the X axis and spun around on the Z axis to see it. The other option is to draw it off to the side at a user defined spot, in a 2D grid. Similar to the command Draw Profile. Shown here are 3 Fence Diagrams drawn in Real World Coordinates, hatched by strata attribute.

![Image of fence diagrams drawn in real world coordinates](image.png)

**Ignore Zero Elevations:** When using the Grids from Drillholes or Intersection methods, the surface topo will be modeled by anything on screen. Selecting this will ignore anything that has an elevation. This is recommended unless the mine is near sea-level.

**Fence Extraction Method:** The Grids from Drillholes method creates a grid model of each strata found in the drillholes "on-the-fly". The program will prompt for the modeling method to use (ie Triangulation or Inverse Distance). These modeling methods are described in the command Make Strata Grid Files for more details. The Pre-Calculated Grids option will use a pre-defined PreCalc file that contains grids and seam names. The PreCalc is made under Drillhole-Define PreCalc Grids. The Intersection method triangulates the drillholes and then finds the intersection of the triangulation mesh and the polyline. In order to obtain data for the strata with the intersection method, the polyline must have at least one drillhole on each side. It is the only way to see a fault in a fence diagram when using the drillholes. Grids from Drillholes does not honor fault lines.

**Process Multiple Named Fence Polylines:** This option allows you to draw multiple fence diagrams at the same time. The diagrams are stacked vertically. Instead of picking a single fence alignment polyline, you can selected multiple polylines that have been tagged as fence polylines using the Tag Fence Polylines command. Each of the fence diagrams is labeled with the fence name assigned to the tagged fence polylines.

**Vertical Spacer Between Diagrams:** This controls the spacing between the multiple fence diagrams when draw more than one at a time.

**Prompt for Additional Surface to Draw:** This setting will allow for selecting another surface file to draw on the fence diagram. An example could be an open pit with benches design that will be drawn on top of the geology, all at the same time. Up to 10 additional surfaces can be drawn and each one has a separate layer name setting. The program prompts for these surface file names and layers in a separate dialog after picking OK on the main Fence Diagram dialog.

**Use Specific Strata Definitions:** This option will allow for selecting a different Defined Strata file than the one that is set current. Use this option and select a different SDF file for layering, colors and hatching.
• **Horizontal Scale:** This is the horizontal scale that will be used to draw the fence diagram. It usually matches the horizontal scale of the drawing.

• **Vertical Scale:** This is the vertical scale that will be used to draw the fence diagram. It usually matches the vertical scale of the drawing. If it is the same as the horizontal scale, the fence will be drawn at a 1:1, with no vertical exaggeration. To get a 2X vertical exaggeration, the vertical scale must be 1/2 of the horizontal scale such as 50H/25V. The same drawing distance represents 50 horizontally and 25 vertically. So it must be twice as tall vertically to equal 50.

• **Horizontal Axis Grid Interval:** This is how often a grid line and tick mark will appear horizontally along the X-axis.

• **Vertical Axis Grid Interval:** This is how often a grid line and tick mark will appear vertically along the Y-axis.

• **Horizontal Axis Text Interval:** This is how often a text label will be drawn on the fence diagram axis. It does not have to match the Grid Interval, but it can.

• **Vertical Axis Text Interval:** This is how often a text label will be drawn on the fence diagram axis. It does not have to match the Grid Interval, but it can.

• **Starting Station:** This is the station that is labeled at the beginning of the fence diagram horizontal X-axis grid. By default it is set to 0.

• **Axis Text Size Scaler:** This is the scaler that is multiplied by the horizontal scale to determine the text size. It applies to both the X and Y axis.

• **Grid Ticks Only:** This option will just draw tick marks at the set grid interval for both horizontal and vertical axis.

• **Draw Plan View:** The Draw Plan View option will graph the drillhole locations above the fence diagram. For this graph, each drillhole is projected onto the baseline polyline to find the station and offset of the drillhole.

• **Plan Vertical Scale:** This is the scale factor for the Plan View drawn above the fence diagram. It is separate, so that the text and drillholes drawn can be different then the fence diagram scale settings if desired.

• **Station by another reference centerline:** This option will station the horizontal X-axis by a predefined centerline CL file. The centerline file will be prompted for during the routine.

• **Draw Surface Polyline:** This option will draw a new polyline along the surface of the fence diagram. It is required if the fence diagram has a pit in it. The surface polyline will not be continuous across the entire fence if there is a pit, as it is broken by outcropping seams. Routines such as Cut and Place run on Fence Diagrams require the surface polyline extends across the pit, so it has a place to spoil. The other, broken surface polylines can be erased if the continuous one is used.

• **Label Northing-Easting:** This option labels the Northing and Easting coordinates along the bottom of the fence diagram at every vertex on the fence line that is drawn in plan view. An example is shown below.
• **Layer Settings**: Layers of fence diagram polylines contains 3 options for drawing the polylines layers. The first one, Layer by Strata Name, will create a layer for each strata name found in the drillholes or PreCalc. There are settings for a prefix and suffix to add to the strata name for the layers. The second option, NonKey on Same Layer, will draw the Key strata and layerize them by strata name. All of the NonKey strata will be drawn on the Fence layer, or any user defined layer in the dialog box. The last option, All on Same Layer, will draw all the polylines on the defined layer "Fence" that appears in the dialog, or any user defined layer. There are separate layers for the Pit Label, Surface Polyline, Fault Line, Additional Surface, Grid Lines and Grid Text layers.

![Layer Settings](image)

• **Label Pit Lines**: When the Label Pit Polylines option is on, the program will prompt you to select polylines with attached pit/site names. These pit names will be labeled with a vertical line and labeled along the bottom of the fence diagram grid at the position where the fence plan view polyline crosses the pit polylines. This option is useful for dragline design commands such as Cut and Place. When set to Tick Mark, the vertical line is a fixed height. When set to Bottom Strata, the vertical line goes from the grid bottom to the bottom strata line.

• **Draw Geologic Columns**: This option will use the Geologic Column command to draw drillholes directly on the Fence Diagram. If a drillhole is at an angle, the fence diagram will show the geologic column at the angle projected onto the fence polyline.
- **Max Offset:** This is the search distance from the polyline that the drillholes will be used for drawing on the fence. Any drillhole further than this distance from the polyline will not be drawn.

- **Settings (Draw Geologic Columns):** This button brings up the Draw Geologic Columns window where all of the settings may be modified.

- **Draw Faults:** This option will draw the fault line on the fence diagram cross section in the place and at the angle that it crosses the cross section. It draws it just as a polyline on top of the fence diagram. The seams should be faulted already, this is just a graphic representation of the placement and angle of the fault. The buffer offset is a way to clean up the seams in the are of the fault. The program offsets the fault line in fence view left and right by this amount. Then it trims the strata lines at this offset. Then it projects the trimmed strata lines onto the original fault line. The purpose is to trim out the transition zone area of the strata. Typically, this area size is about the same as the grid cell size of the strata model. So a good buffer offset size is to use the grid cell size. Shown here are the grids without the fault drawn on it, cleaning up the grids, and also with the 45 degree fault drawn. Notice the large difference in how the fence is displayed with the Draw Faults on.

- **Hatch Fence:** Turn this option on to hatch the strata in the fence, otherwise leave it off to just draw polylines. The strata hatch patterns are defined in the Define Strata command. If this is selected, then the hatch patterns defined there will be used. If a strata exists that is not defined, it will use the default hatch in Pattern Name.

- **Pattern:** The default hatch pattern is used if there is no pattern defined for that strata. This can be MDST or SOLID, for example.

- **Select Pattern (Hatch):** Selecting this button brings up the pages of geological hatch patterns to choose from.

- **Scaler:** This is the scale factor that is applied to the hatch pattern in the Fence diagram. A factor of 1.00 here will use the default hatch pattern scale factor set with Drawing Setup.

- **Rotate:** The Rotate option for hatching rotates the hatch pattern to best fit the angle of the strata. A hatch pattern can have only one rotation, so rotating will not be effective for a strata with multiple rotations. There is also the Azimuth option in the Define Strata command to rotate the hatch.

- **Clip Intersecting Strata:** This option is useful to check for crossing grid files. It is ON by default. Turning the option off will draw the polylines as they are in the grids or modeled from the drillholes. It is only active if the hatch option is turned off, and the fence is just drawn as polylines. Shown below is an example of the crossing polylines in a Fence Diagram. This means the grids or modeling might be suspect and should be cleaned up.

- **Draw Key Strata Only:** This option will draw and hatch just the Key strata on the fence diagram. The Non-Key intervals found in between the Key will be left as empty gaps.
• **Max Drillhole Offset from Line:** A maximum distance offset from the baseline polyline can be specified to filter out drillholes beyond the area of interest.

• **Hatch Key Strata Only:** This option will just hatch inside the Key strata that are drawn. The NonKey strata will be just polylines, with no hatch inside. Shown here is an example that has just the Key strata hatched, but also the limit lines are used to define the breaks between the splitting seams. Notice the nice, vertical contact from a full seam to a split seam.

• **Hatch By Block Model:** This option will hatch the seams using the GPF Grade Parameter File and the Block Model BLK files. A legend of the grades can be drawn also in the Define Grade Parameter screen. This is a great option to use to show the changing quality not only horizontally, but also vertically in the geology.

• **Hatch By Strata Attribute:** This option is similar to Hatch by Block Model, except there is no Grade Parameter File required. It will look at look at the quality attributes found in the PreCalc, or in the drillholes, and bring up a list. Select an attribute to hatch by. Then a color palette will appear, allowing to set the colors and ranges of the different "zones". This will just change the hatch horizontally across the strata, not vertically as the Block Model does. Shown below is an example of coal seams colored by BTU.
• **Draw Legend:** Use the Draw Legend option to make a legend of the strata hatch patterns and colors. There will be a prompt to pick the location to draw the legend.

• **Legend Scale:** This is the scale factor to size the legend.

• **Bottom Hatch Scaler:** This is the scale factor to use for the strata that appears at the very bottom of the fence diagram. If using a solid, then no scale is applied, but any other hatch pattern will use a scale factor.

• **Auto Scale Hatch Pattern:** This option will auto fit the hatching inside the strata perimeters.

• **Load/Save:** All of the switches and settings can be saved and loaded with these buttons. It creates a FEN file containing all of the settings.

**Prompts**

*Fence Diagram Settings dialog box*

Select polyline to pull fence diagram from: *pick the polyline*

Select surface entities & at least 3 drillholes.

Select objects: *Select the drillhole symbols and surface entities.* Surface entities can include points, lines, and polylines.

Reading points ... 139

Reading drillholes ...

Choose modeling method (<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq)? *Press Enter*

Bottom elevation of grid <1600.00>: *press Enter to accept default*

Top elevation of grid <2000.00>: *press Enter to accept default*

Pick the lower left corner for the fence diagram: *pick a point in a clear area of the drawing*

Pulldown Menu Location: StrataCalc

Keyboard Command: fence

Prerequisite: Drillholes or Pre-Calculated Grids, and a fence alignment polyline

*Chapter 14. Geology Module* 2528
Quick Fence is very similar to Quick Profile, in that an instant profile appears at the bottom of the screen, displaying the surfaces. This fence alignment can be set by picking points, selecting a centerline file, or selecting a polyline from the screen. A triangle appears in the plan view as the cross hairs are moved along the fence diagram below. This displays where along the fence line the cross hairs are. The slope of the surface, the station and elevation appear dynamically below the buttons. The Adjust Alignment function allows you to drag a horizontal alignment point and update the fence diagram in real-time for quick and efficient grid model verification.

- **Vertical Exaggeration:** This usually starts at "Fit" to size the fence diagram into the window. The other exaggerators, x1, x2, x5 and x10 can be selected to exaggerate it vertically.

- **Drag Action:** The fence image can be modified with either the zoom or pan actions.

- **Grid Ticks Only:** Turning off this box will extend the elevation and stationing tick marks all the way across the fence diagram.

- **Save:** This option will save the surface as a *.PRO profile

- **Draw:** Selecting this will put the fence diagram in the drawing with the Draw Profile command. The result will be similar to Draw Profile with multiple surfaces.

- **Print:** This will print the fence diagram to a PDF file.

- **Adjust Alignment:** This option allows for the fence line on screen to be moved. If the center of the polyline is selected, then the fence line can be moved in any direction, and the seams will dynamically update as the polyline is moved around. If one of the endpoints is selected, then the fence line can be rotated around the other endpoint, or extended to another length. This is a great tool to do a quick check of the geological grids with real time graphic feed back on the model status.

**Prompts**

Select the Precalculated Grids File (*.PRE)
Pick starting point (CL-Centerline,P-Polyline): p if the polyline is drawn on screen
Polyline should have been drawn in direction of increasing stations.
Fence Polylines

There are three commands for managing fence polylines. The fence polylines are used by the Fence Diagram command as the horizontal alignment. You can run Fence Diagram without pre-defined fence polylines and pick the alignment polyline on-the-fly. One advantage with using fence polylines is that you can specify the alignment polyline once and then more easily select the fence polyline in Fence Diagram which is useful if you run Fence Diagram multiple times for the same alignment. Another advantage is that you can use fence polylines to run Fence Diagram on multiple alignments at the same time.

The fence polyline commands are Tag, Untag and Identify. The Tag Fence Polylines command prompts you to pick a polyline and give it a name. This polyline is then flagged as a fence polyline. The Untag Fence Polylines command removes the tags from the selected polylines. The Identify Fence Polylines command reports the name of the fence polyline. For Identify, you can either report the names for the individually picked polylines or have the program search the whole drawing and report the locations and names for any fence polylines.

Prompts

Tag Fence Polylines
Select fence alignment polyline: *pick a polyline*
Fence name <Fence 1>: *West Pit*
Select fence alignment polyline (Enter to end): *press Enter*

Identify Fence Polylines
Pick polylines to check or search drawing [<Pick>/Search]: *S for search*
Fence polyline West Pit at 1645793.98,244010.72, Layer: FENCE
Highlighted 1 fence polylines.

Untag Fence Polylines
Select polylines to remove fence alignment name.
Select objects: *pick the polylines to process*

Block Diagram

Block Diagram creates a 3D cut out of the site with contours and/or grid mesh on top and fence diagrams or solid faces on the sides. The options for gridding and contours are shown in the first dialog box. The second dialog shows the options for the fence diagrams and grid. The strata hatch patterns are defined in the Define Strata command. The default hatch pattern at the bottom of the dialog is used if there is no pattern defined for that strata. In order to process a strata for the fence diagrams, there must be at least one drillhole inside and at least one outside the block diagram box. This command is basically a 3D Fence Diagram, with grid faces or contours on top. All of these options are defined in Make 3D Grid File and Draw Fence Diagram.
Prompts

Pick or enter Lower Left block corner:
Pick or enter Upper Right block corner:
Reading cell > 194032
Pass > 7 Null Z values left > 0
Calling fence
Drawing strata OVERBURDEN
Drawing strata C1
Drawing strata PARTING
Drawing strata C2
Drawing grid text ...
Draw Voroni Diagram

A Voronoi diagram is a special kind of decomposition of a metric space determined by distances to a specified discrete set of objects in the space, or, by a discrete set of points or drillholes. It is useful here to divide the mine area up into polygon linework for the area of influence around drillholes. These are individual polyline segments, not closed polylines.

The first dialog prompts for the layer name for the diagram linework to create. The Process Method chooses between using all the drillholes at data points for the diagram or using only drillholes that have a certain strata and attribute.

When using Strata/Attribute, the next dialog asks for a strata to analyze.
The next dialog prompts for the value to process.

Prompts

Select drillholes, channel samples and strata polylines.
Select objects: Specify opposite corner: 437 found
Reading drillhole 437
Finding splits ...
Processing only strata with beds.
Select closed inclusion polyline: There must be an inclusion polyline selected with this command.

Drop-Down Menu Location: StrataCalc
Keyboard Command: CHVORONOI
Prerequisite: Drillholes
Color Elevation Grid by Strata

This routine colors the 3D grid faces plotted in the drawing. It uses the colors defined by layers, or in the strata definition file and matches the names up with the intervals in the PreCalc. It is very useful for locating the outcrop of strata, or displaying the subcrops of seams to a mining bench grid. This colored grid can then be viewed in 3D and shaded for full visual effect. Shown below is a final pit of a sand and gravel quarry. The grid has been colored by the seams defined in the PreCalc file. There are options to set the subdivision tolerance. 0 will not subdivide the grid cells. A max of 5 will subdivide the grid into very small cells, for example, 50 x 50 grids will subdivide down to 1.5 x 1.5. There is also an option to use the SDF file from Define Strata for the coloring and layers.

Prompts

Select the PreCalc file
Reading cell > 21364
Select 3D Faces to Process... type all or window the faces
Select objects: Specify opposite corner: 18340 found
Use Layers from Strata Definition File [Yes/<No>]? y
Enter Max Subdivision Level (0-5)<3>: 0
Select 3D Faces to Process...
Select objects: Specify opposite corner: 5005 found
Select objects:
Draw Legend [Yes/<No>]? y
Enter Legend Size <25.0>: 
Pick Legend position: pick location for legend
Select objects: Enter to accept

Keyboard Command: strata_color
Pull-down Menu Location: StrataCalc
Prerequisite: Need a 3D Grid plotted in the drawing and a PreCalc containing grids that intersect the plotted grid.

Block Model Menu

The Block Model menu has commands for creating and viewing block models as well as pit optimization.
**Make Block Model**

This is one of the initial commands to begin using the block modeling features of Carlson. It uses similar grid logic, for location and resolution in the X and Y. It will take bed and subdivide it into vertical divisions. This can be applied to stratafied deposits, or ore based geology, where it is not stratafied, such as limestone or copper, gold and silver. In these ore type cases, the strata or bed name could be just rock, or limestone all the way down the hole. It would then look at just the quality being modeled as the variable. The program takes this interval, makes a roof and a floor and divides it up equally into the number of vertical divisions specified, or at an elevation "lift", where the top and bottom elevations are specified, and the block height calculated based on the number of divisions.

The first dialog brings up the Select Bed and Attribute screen. One bed name must be selected, and one or more attributes selected. If there are no Bed names in the drillholes, then select the Model By Strata Names box to use just Strata names.
The next screen, Make Block Model, is for dimension and modeling settings. The number of cells in the X and Y direction are shown at the top. The total number of cells in plan view is shown next. The block height is determined by the Number of Vertical Divisions and Vertical Position settings. There are two options to determine the Vertical Position. The first one is by Fixed Elevations. This will activate the Bottom Z and Top Z windows where the roof and floor for the block model are entered. The Follow Ore Model makes the top and bottom of the block model follow the top and bottom elevations of the bed being processed. The Use Fixed Elevations for Ore Model controls how the attributes are interpolated for the Fixed Elevations mode. When this option is on, the attributes are calculated at the fixed elevations. When this option is off, the attributes are calculated within the elevation range of the bed and then interpolated to fit within the fixed elevations. The Number of Vertical Divisions controls the number of block model data points between the top and bottom of the block model.

Make Block Model uses 3D Inverse Distance, 3D Kriging or Discrete as the modeling method to produce the block model of the quality values. The Prompt Each Attribute will allow for different methods for different grades in the block modeling. For example, Calcium can be modeled with Inversed Distance and Magnesium modeled with Kriging. It will prompt for each before writing the BLK file. The distance weight for the 3D inverse distance is the combination of the X-Y distance and the Z distance. This vertical factor is multiplied by the Z distance. So if there is no special correlation in the deposit for vertical, then the vertical factor should be set to 1. If there is some strata-like correlation based on deposit level, then this vertical factor should be set greater than 1, such as 10. Inverse Distance horizontal weighting factor, and ellipsoid is prompted for at the command line with: "Use inverse distance to which power [First/<Second>/Third/Other]?" and "Use elliptical inverse distance [Yes/<No>]?"

Discrete is a method to model parameters such as color. It will carry one color 1/2 way over to the next drillhole, then switch to the other color. This way, there is now blending of colors, if color1 is a 2 in one drillhole and color2 is a 4 in the next drillhole, it will not blend them to a "3" in the middle. It models 2, and then switches to 4 at the half way point.
After the routine is finished calculating, it creates a *.BLK file. This file can be viewed in a text editor to see what it contains, as shown here. Basically, it shows the roof and floor, the quality attribute name and the file paths of each level of the block qualities.

Keyboard Command: BLKMODEL
Pull-down Menu Location: Block Model
Prerequisite: Drillholes with a bed name, and variable quality values that can be vertically modeled.

Input-Edit Block Model
This command allows for creating the block model from pre-made grids, not using drillholes. It looks uses a grid file for the top and bottom of the ore zone. It then will reference at least one quality grid file for each vertical division. This is useful if the roof and floor grids already exist, and they will be used instead of grids made by other routines, such as Make Block Model. The dialogs are very easy to get around in.
Choosing the Add or Edit button will bring up the Edit Block Attribute window. The attribute name is entered at the top. The user can add up to 500 vertical divisions or grids. Save the block model as a BLK file for plotting and for use in Fence Diagram and Surface Reserves.

**Pulldown Menu Location:** Block Model  
**Keyboard Command:** blkedit  
**Prerequisite:** Grids of at least the roof and floor, and a quality grid

### Import Block Model

This command imports Q-Pit program block models and Vulcan Block Models from ascii files. The first window is used to select the block model to be imported.

**Q-Pit Block Model**

It will prompt for a ascii file to be selected, then create a Carlson BLK file.

**Vulcan Block Model**

This command allows the user to specify the grade parameters. First, select the Vulcan Block Model file and then the Import Vulcan Block Model window pops up. The coordinate columns X, Y and Z must be specified along with at least one other grade parameter. The Add Attribute button can be used to create a new attribute, The Add Skip
button could be used to skip a corresponding column. File types that it currently looks for are ASC, DAT, CSV, and TXT.

Once that is defined, the user is prompted to select the Carlson Block Model (blk) file to save the resulting block model to.

**Pulldown Menu Location:** Block Model

**Keyboard Command:** readblkm

**Prerequisite:** File to import

### Define Grade Parameters

This command creates the attribute file for the block model. It contains the attributes, grade names, prices and the ranges. The Name of the grade may appear on the list more than once, if several options exist to create a certain grade.

Choosing Add or Edit brings up the Edit Grade Parameters screen for up to 50 parameters at once to define a certain grade and color. There are six Operators: $<$, $>$, $<=$, $>=$, $=$, and Not $=$, combined with either AND or OR for defining the grades.
The Draw Legend button places a legend in the drawing as shown here where the grade name is displayed next to the color sample in the legend. The user chooses the legend layer and size. This is useful after color hatching a fence diagram. Drawing the legend next to the fence diagram is a good reference to see the quality of the ore.

**Prompts**

**Pick location for legend**: pick location on screen  
**Layer name for legend** `<LEGEND>`: Enter to select  
**Size for legend** `<20.0>`: Enter or change size  
**Keyboard Command**: DEFATTRF  
**Pull-down Menu Location**: Ore  
**Prerequisite**: Need to run Make, or Input-Edit Block Model first to get the BLK file. Then define the quality/grade parameter values and their color scheme.
Draw Block Model

This draws the block model in the drawing which can be rendered in 3D for visualization with the 3D Viewer Window. There are two options to use grids to limit the top surface and the bottom surface of the blocks to be drawn. This way, if there is a new topography of the pit, it will only draw blocks of the remaining ore. There is an option to use an inclusion perimeter to draw the blocks inside.

The first dialog shows the Grades, the Layer for each grade and whether to draw them or not. The block model is then drawn. It may be viewed in 3D in the drawing to see the various grades, or loaded into the 3D Viewer Window. It detects the block model and prompts to be rendered.
This will give a 3D rendered image of the blocks colored by grade as shown here. Using the Advanced Options of the 3D Viewer Window, colors can be turned on or off to see what is in the center, behind other grades.

The first step is to select the *.BLK file, then select the *.GPF file.

**Prompts**

Keyboard Command: drawblkm
Pull-down Menu Location: Block Model
Prerequisite: Need a *.BLK file and a *.GPF file from Make Block Model, Input-Edit Block Model and Define Grade Parameters.

**Label Block Model**

This command is an automatic way to label the grades of a block model between two surfaces. There are options for symbols, text size, decimal precision and the CAD layer it will be drawn on.

![Label Block Model Dialog Box](image)

The Block Model and Grade Parameters are set first. Then there is the optional Surface Topo and Bottom Limit Surface to contain the labels to just that depth for the labels. This is useful if the blocks within a certain bench height from 1540 down to 1495 elevation are to be labeled. Once OK is selected, there are prompts to select an inclusion and exclusion perimeter. After that is an option to skip over block cells to label. This will create fewer labels based on how many are skipped over.

![Label Block Model Results](image)

**Prompts**
Select the Inclusion perimeter polylines or ENTER for none.
Select objects: 1 found
Select the Exclusion perimeter polylines or ENTER for none.
Number of cell to skip<2>:

Pulldown Menu Location: Block Model
Keyboard Command: label_blkm
Prerequisite: Need a BLK model file and a GPF grade parameter file.

Color Pits by Grade Parameters
This command colors pits by assigned grade color from grade parameters file. It could be useful in identifying the pits with different grades/qualities.

Prompts
Color Pits by Grade Parameters
Select all directioned pit polylines.
Select objects: all
202 found
Select objects: press Enter
Enter bench number to hatch (1-4): 4, enter bench number to be colored
Pull-down Menu Location: Block Model
Keyboard Command: pitcolor
Prerequisite: Grade Parameter File (gpf) and Surface Pits with directions and quantities

Color Elevation Grid by Block Model

This command will color the 3D faces of an elevation grid plotted on screen or of a flat user defined elevation based on the Grade Parameter File or by a single attribute, where the color palette is selected separately.

After selecting the Block model file (*.BLK), the following dialog box prompts for Single or File for the color scheme. Selecting File would use the predefined *.GPF file. Choosing Single leads to the next colorful dialog box to specify the ranges. The Max Subdivision Level allows for a tolerance to subdivide the cells or blocks. Zero (0) will not subdivide them. A maximum of 4 will subdivide them into very small segments. The option to Draw No Grade 3D Faces will leave gaps where the parameters of the block model don't meet any of the grades. There is the option to use On-Screen 3D Faces or to simply enter an elevation to represent the grid.
The result is a colored grid mesh or elevation that can be rendered and viewed in 3D.
Prompts

Reading cell > 4828
Select 3D Faces to Process... type all or window the faces
Select objects: Specify opposite corner: 15779 found, 11552 were filtered out.
Select objects: Enter to accept
Keyboard Command: BLKCOLOR
Pull-down Menu Location: Ore
Prerequisite: Need a *.BLK model file and a grid drawn on screen.

Block Model Inspector
This command displays the from and to depths, and the grade value as the cursor is moved across the block modeled area. The location can be labeled with a left mouse click to put the text in the drawing. This is a quick way to check the model and for labeling maps to give to the field crew showing the depth range and grade. If "Use Surface Topo" option is on, the depth is calculated from the "Surface Grid" and labeled as "Over Burden Name", such as OB. The Use Bottom Limit Surface will contain the model so that it only labels down to it, such as a flat bench elevation, or pit floor grid. If there exists a no-grade zone for certain elevation range this zone is reported as No-Grade zone.
Prompts

Reading cell > 4828
Select symbols/<Enter or pick point>:

Pull down Menu Location: Block Model  
Keyboard Command: blkm_inspector  
Prerequisite: Need a BLK model file and a GPF grade parameter file.
Block Model 3D Viewer

This command is a quick way to view the block model in the 3D Viewer window without having to draw the block model first. Once the viewer is up, the rotation, zoom and rendering are all the same as the 3D Viewer window routine.

Pulldown Menu Location: Block Model
Keyboard Command: blkm_cube
Prerequisite: A BLK model file and a GPF grade parameter file.

Block Model Statistics

This command is used to report data value statistics on each grid or over all statistics within the block model. The user is prompted to select one of the reporting method, Report by Attribute/Quality or Report by Levels/Grids. The reports are generated using report formatter.
Prompts

Select inclusion perimeter polyline (Enter for None): press Enter

Pulldown Menu Location: Block Model
Keyboard Command: blkstats
Prerequisite: Need a BLK model file

Prepare Value Block Model

This command makes a block model that represents the profit of each block. There are two options, to just Enter the Economic Parameters or to Read Grid Parameters File. A 3-D fixed block model is used for computerized optimization techniques. Carlson defines a block model with a block file (*.blk) and top elevation grid file, bottom elevation grid file and grid files with grade parameters for each layer. The block dimensions are dependent on the physical characteristics of the mine, such as pit slopes, dip of deposit and grade variability as well as the equipment used. The center of each block is assigned, based on drill hole data and a numerical technique, a grade representation of the whole block. Carlson uses inverse distance method, 3D Kriging, and discrete method to estimate grades for each block. A block model can be created using the "Make Block Model" (Command: blkmodel) or the Input-Edit Block Model commands from "Ore" menu.

A value block model consists blocks with profit ($/block) values associated with them. These profit values are calculated based on the grade values of the blocks. The command to make value block model starts with a dialog to choose Carlson block model to process. The first dialog is for selecting the Method for Preparing the Value Block Model. The first option, to Enter the Economic Parameters brings up the following window where the final Ore or Metal Price is set in $/lb for all the key ore.
The second option, to Read Grid Parameters File, brings up the following window where price for each grade ($/lb) appears just as it is entered in the Grade Parameters file GPF.
Each of the input parameters are described below:

- **Metal Price ($/lb)**: The price obtained for a lb of final product
- **Ore Mining Cost ($/ton)**: Cost associated with mining a ton of ore
- **Ore Processing Cost ($/ton)**: Cost associated with processing a ton of ore
- **Waste Mining Cost ($/ton)**: Cost associated with mining a ton of waste
- **Metal Treatment Cost ($/lb)**: Cost associated with treatment of a lb of ore
- **% Recovery**: The fraction of contained product recovered during processing
- **lbs/ton (Default=2204.6)**: Factor used to convert tons into lbs, 2204.6 for long ton and 2000 for short ton
- **Ore Tonnage Factor or Sp. Gravity (cubic ft/ton)**: Density of the ore
- **Waste Tonnage Factor (cubic ft/ton)**: Density of the waste
- **Pit Layback Slope (degree)**: Overall slope of the pit highwalls
- **Vertical divisions (# of Benches)**: This is the number of benches allowed for the surface pit

Using the above input values, first the **Net value/lb** for ore is calculated as follows:

\[ n = \text{Netvalue/lb} = (\text{Metal Price} - \text{Treatment cost}) \times \text{recovery/100$/lb} \]

\[ c = \text{ore mining cost} + \text{ore processing cost} + \text{waste mining cost} \]

Then calculate the Cutoff grade: \( x \% \)

\[ (x/100) \times \text{lb/ton} \times n = c \]

And Mill cutoff grade: \( y\% \)

\[ (y/100) \times \text{lb/ton} \times n = (c - \text{Ore processing cost}) \]
Now we already know the block size (height, width and length) so we can calculate its volume \( V = h \times w \times l \) ft\(^3\). And with tonnage factor we can calculate tons/block = \( Tb = \frac{V}{\text{tonnage factor}} \). Then Profit associated with each block is calculated based on its Grade value that is read from GPF file:

For any block
(a) if Grade is less than \(< y\)

- Revenue = 0
- Cost = \( Tb \times \text{Waste Mining Cost} \)
- Profit = Revenue - Cost

(b) if Grade is greater than \(y\) but less than \(x\)

- Revenue = \( Tb \times \left( \frac{\text{ore grade of the block}}{100} \right) \times \left( \text{Metal Price} \times \frac{\text{lb/ton}}{} \right) \)
- Cost = \( Tb \times (\text{Ore Mining Cost} + \text{Ore Processing Cost} + \text{Ore Treatment Cost}) \)
- Profit = Revenue - Cost

(c) if Grade is greater than \(x\)

- Revenue = \( Tb \times \left( \frac{\text{ore grade of the block}}{100} \right) \times \left( \text{Metal Price} \times \frac{\text{lb/ton}}{} \right) \)
- Cost = \( Tb \times (\text{Ore Mining Cost} + \text{Ore Processing Cost} + \text{Ore Treatment Cost}) \)
- Profit = Revenue - Cost

The blocks with positive Profit are treated as profitable block and the profit value associated with each block is saved in new BLK and GRD files. Then the Lerchs Grossmann Algorithm is used on this Economic Value Block Model to calculate the optimum pit. If the grade block model has more than one attribute (grades) then economic parameters are read from gpf file, otherwise economic and physical parameters are entered directly to create the new value block model. A surface grid file is read to create the surface of the new block model. All the blocks that lie between surface grid and top elevation of the grade block model are treated as waste blocks i.e. grade is assigned to zero for those blocks. The number of blocks and size of blocks in the new block model are calculated based on the physical parameters, pit layback slope angle and number of vertical divisions. The block values (grade) for the new block model are estimated using the original block model. Profit (dollars/block) associated with each block is calculated based on its physical and economical parameters. The blocks with positive profit are treated as ore block. The Value Block Model is saved as a new Carlson block model file (*.blk). There are file selection windows to first select the existing block model (BLK file), the surface Topo grid file and the new Value Block Model to write. The final step is to write out the Value Block Model that may be used in other routines, such as Optimized Pit Design. **Keyboard Command:** mkvalblkm **Pull-down Menu Location:** Block Model

**Prerequisite:** Need a BLK model file, a topo grid file and optionally a GPF grade parameter file.

**Optimized Pit Design**

This command uses the Lerchs-Grossmann Algorithm (LGA) to determine the optimized minable pit. Determining the optimum ultimate pit of a mine is the base of mine planning. The optimum ultimate pit of a mine is defined as the "pit shell contour", which is the result of extracting the volume of material that provides the total maximum profit while satisfying the operational requirements of safe wall slopes. The ultimate pit limit gives the shape of the mine at the end of its life. Usually this contour is smoothed to produce the final pit outline. Optimum pit design plays a major role in all stages of the life of an open pit:

- At the feasibility study stage when there is a need to produce a whole-of-life pit design;
- At the operating phase when pits need to be developed to respond to changes in metal prices, costs, ore reserves, and wall slopes; and
- Towards the end of a mine’s life where the final pit design may allow the economic termination of a project.
At all stages there is a need for constant monitoring of the optimum pit, to facilitate the best long-term, medium-term and short-term mine planning and subsequent exploitation of the reserve. The optimum pit and mine planning are dynamic concepts requiring constant review. Thus the pit optimization technique should be regarded as a powerful and necessary management tool. Further, the pit optimization method must be highly efficient to allow for an effective sensitivity analysis. The ultimate pit limit problem has been efficiently solved using the Lerchs-Grossmann graph theoretic algorithm.

**Lerchs-Grossmann Algorithm for ultimate pit design**
Following is a detailed description of the internal workings of the algorithm.

1. Define a cutoff grade for the mine.

2. Consider the physical location of the Blocks.

3. Calculate the average grade value (profit or loss) associated with each block. This is done with the command Prepare Value Block Model.

4. Considering that overlying blocks must be removed before mining the lower blocks, find possible connections of blocks from lower level to upper levels.
   - 1-5 pattern (at least 2 common vertices between lower and upper blocks)
   - 1-9 pattern (at least one common vertex between lower and upper blocks)

5. Imagine a dummy root (X0) connected to all the blocks with arcs and form a tree T0, assign M (profit) to all the arcs.

6. Assign direction to arcs
   - Plus - if arc is directed away from the root.
   - Minus - if arc is directed towards the root. (Note: Initially all the arcs will be in "Plus" direction.)

<table>
<thead>
<tr>
<th>Case</th>
<th>Direction</th>
<th>Profit</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Plus</td>
<td>Positive</td>
<td>Strong</td>
</tr>
<tr>
<td>2</td>
<td>Plus</td>
<td>Null or negative</td>
<td>Weak</td>
</tr>
<tr>
<td>3</td>
<td>Minus</td>
<td>Positive</td>
<td>Weak</td>
</tr>
<tr>
<td>4</td>
<td>Minus</td>
<td>Null or negative</td>
<td>Strong</td>
</tr>
</tbody>
</table>

8. Divide all the arcs into two groups "Y" and "X-Y".
   - "Y" - contain all the arcs labeled "Strong".
   - "X-Y" - contain all the arcs labeled "Weak".

9. Find all possible directed arcs from group "Y" to "X-Y", if there are no possible arcs from group "Y" to "X-Y" the tree has normalized and the blocks belonging to group "Y" will be mined to give maximum profit, else go to next step.

10. Choose any possible arc (Xk, Xl) such that Xk belongs to group "Y", and Xl belongs to group "X-Y". Determine Xm, strong root of Xk connected to dummy root X0.

11. Drop arc (X0, Xl) and connect (Xk, Xl) and construct a new tree Ti.
12. Update weights according to following transformation

- For an edge $e_i$ on the chain $[X_m ....... X_k] = \Rightarrow M_{newi} = M_m - M_{oldi}$
- For edge $(X_k, X_l) M_k = M_m$
- For an edge $e_j$ on the chain $[X_l...........X_p, X_0] = \Rightarrow M_{newj} = M_m+M_{oldj}$

13. Go to step 6 and repeat the procedure again.

This application is developed using a modified version of LGA. Here we consider only two consecutive branches at a time and normalize them and update the weights or values associated with the each node in the grid.

**Ultimate Pit and Cyclic Production Report Generation**

A pre-existing value (profit) block model is selected to process form this command. The block model is processed using Lerchs Grossmann Algorithm (LGA) to find the Ultimate Optimum pit. There are two methods to determine the ultimate pit. The first method will use the LGA For All Levels. This brings up the second dialog box, where the Total number of blocks is displayed. Below that is the Total Volume, and the breakdown of number of Ore Blocks and # of Waste Blocks. There are two output methods here. Save the Ultimate Pit grid, which will prompt for a new BLK file to save out, and save the Bottom Pit Grid, which will prompt for a new grid file to create, of the bottom of pit surface.

![Select Method for Optimum Pit](image1)

LGA-For All Levels takes all the benches into account at the same time and if there exists an optimum pit, it will find it. It takes care of the constraint that the algorithm for two levels uses. As this one is a iterative process it takes a little long to find the optimum pit if we have large block model.

![Optimized Pit Design](image2)

LGA-For Two Levels will bring up the next dialog window.

![Select Method for Optimum Pit](image3)
LGA-For Two Levels considers only TWO BENCHES at a time, starting from top to bottom. Let's say we have 5 benches in our block model, it takes into consideration bench 1 (top bench) and 2 and finds the optimum pit and updates the profit values of them. Then it takes bench 2 (this bench has updated weights or profit values) and 3, and repeats the same steps for the rest of the benches. The main constraint with this algorithm is that if you more than 2 benches of over burden it will not work.

The following items are shown at the top of the dialog. These are calculated using the LGA on the predefined Value Block Model.

- Total number of blocks
- Total Volume (Ore+Waste) (KTons)
- # of Ore Blocks
- # of Waste Blocks
- Number of blocks in the optimum pit
- Total Mineable Reserve (KTons)

The next 6 items are input values used for creating a cycle or schedule report.

- Cycle Target Blocks: This is the number of blocks that can be mined per cycle period.
- Cycle Target Production (KTons): These are the tons that can be produced per cycle period.
- Total Target Blocks: This is the total number of blocks to be mined in all the cycle periods.
- Total Target Production (KTons): These are the total tons to be mined in all the cycle periods.
- Block Tolerance: This is the tolerance allowed per cycle. +/- this many blocks per cycle period.
- Prefix to save Cycle Block Models: Enter the prefix to assign to the output block model.

The final four check boxes are options to create the output files. The Save Ultimate Pit creates an output BLK file. The Save Remainder Pit is the pit left by mining the total targeted blocks, also saved as a BLK file. All cyclic pits (block models) are saved with given prefix and a cyclic production report is generated showing production and economic details of all the cycles. The Bottom pit grid file can only be saved with save ultimate pit and save remainder pit options selected. The Cyclic Report gives the production per cycle defined.

The values of the ULTIMATE PIT BLK file should be the same as it was in the value block model except for the blocks which has to be mined, it assigns NULL value to the blocks that are to be mined, so that we can visualize what the blocks are that are in the group that is to be mined. The rest of the blocks will have either +ve or -ve values based on whether its a Profit Block or Non-Profit block.

Here is an example of a limestone quarry. Consider the two views of the geologic block model. With the lowest grade removed (yellow), the highest grade, green can be seen. After creating the Value Block Model and generating the Ultimate Optimized Pit, these next views show where it can be mined by running the LGA on the Value Block Model. The first shot is of the value block model. Make a new Grade Parameter File to show Profit and Loss. In this case, Red is Loss, and Green is Profit, but there may be numerous intervals. Then use the Block Model Viewer to see the "before and after."
The final shot is of the output grid file representing the ultimate pit. The original contours are shown above the final grid surface for comparison.
Limitations
There are a few limitations that need to be considered when creating the optimum pit at this time. Future releases might look into some of these.

- The variation in mining cost with depth is not considered.
- Only one layback slope angle can be assigned to all the benches.
- On large models, the speed will be very slow.
- It cannot handle a block model with three benches (layers) of overburden or three consecutive waste benches (layers).
- Sometimes algorithm may not converse for desired number of blocks in that case changing block tolerance might help.
- All cycle block models produced cannot be viewed in 3D viewer at the same time.
- The dimensions and starting coordinates should match in surface grid file and rest block model grid files.

Pulldown Menu Location: Block Model
Keyboard Command: bestpit
Prerequisite: Need a value block model

Production By Block Model
The Production By Block Model is intended to organize grids or triangulation files created by the Carlson Software Civil Design or Mining modules into mineable blocks. The software analyzes each block to report the amounts and qualities of each seam contained in the block. During layout, the analyzed blocks may be subdivided along elevations, or along strata intersections. Only the top-most block in a series of stacked blocks is "active" to the software. Once a block is mined, the next layer of blocks becomes available for selection. Once the model is built, the model files may be transferred to any computer, with or without Carlson, to allow mine personnel to query, build mine plans, and/or mark blocks as mined. The following diagram illustrates the concept where the example blocks are shown in bold.
The block size may be determined to represent an economically viable mining volume, a series of bench elevations or any combination of layout. Blocks may be any size and shape with a single set of requirements:

- All blocks stack on top of similarly shaped blocks,
- Blocks are arranged in a series of constant thickness.

1. Setting Up The Pick and Choose Model

The process for analyzing the Block Model is as follows:

- Define the Pits (Separate Mining Areas)
- Define the Carlson grid or TIN files that describe the subsurface for each pit
- Define Admixtures (future enhancement)
- Layout Blocks for each pit
- Build The Model for each pit
- Analyze the model

The menu structure of the software is organized in the same order:
The first step is to give the model a name. That can be accomplished under the File pulldown menu, Set option. Alternatively, the software will ask for the same information if any other button is pressed before setting the model file. The screen will appear as:

Enter the name and location of the model. If you enter a file that does not exist, the software will ask if you want to create a new one.

2. Defining Pits

Pits are simply names of separate mining areas. Each area has its own set of grid files, even though the files are the same throughout the project. All projects must have at least one pit. New models include this pit and assign its name as 'Default'. Press the "Define Pits" button on the main screen to rename, or add pits. The screen will appear as:

Click on a Pit Name in the list. The name will appear in the bottom entry box. It may be edited there. The pit named DEFAULT may not be renamed unless more than one pit exists.

Press the New button to add a name. A box will appear where the name can be entered for the new pit. When pits are renamed in the bottom box, the change is not recorded until you click on another name in the list. The Cancel button will discard all changes made while on the screen.

3. Specify Model
Set the model file, and the pit on the main screen shown here:

This shows where the model is set to X:\425-002\200407\test, and the pit is set to DEFAULT. Press the Specify Model to obtain a page similar to:

The mining model entry is made in the grid or spreadsheet on the dialog. Mining materials (strata) are defined along the top of the spreadsheet, and attributes (qualities) are listed along the left edge. Every material in the block has the opportunity to relate to every quality. Items that do not apply, are simply left blank in the grid.

Grid or triangulation files may be entered as the defining limits and the qualities of the materials in the blocks. The files are NOT required to be of equal spans, or spacing in grids, and do NOT need to be of similar shape in triangulations. They should, however, cover the entire area of the block model. Blocks falling outside the file limits of a particular area will have that particular volume or quality set to nothing (no data.)
The first pit in the list (DEFAULT or to whatever it has been renamed), defines the material(s) and attached quality(s) associated with each material. All materials (strata) and qualities used in each pit must be defined in the first pit, even if they do not exist. Calculations are made on a regular spacing in the limit of the blocks. This calculation spacing is defined by the user in the box 'Common Calculation Spacing.' This box must be filled in on the first pit, before the entry page is saved to the model or the software warns that it is blank.

4. Manual Entry:

- **Adding materials:** Insert a material (strata) by pressing the Insert Strata button. Enter a name in the box and press enter.
- **Adding qualities:** Insert a quality (attribute) by pressing the Add Quality button. Enter a name in the box and press enter.

The example entered here was 'burden' as a strata, and 'MAG' as a quality:

![Model Specification for Pit DEFAULT](image)

5. Entering File Names In The Spreadsheet:

Move the cursor to an appropriate cell in the spreadsheet and double-click the cell with the mouse. Select the file and press OK. The file name will appear in the box. Materials are defined as top and bottom elevations or a series of thickness files. To establish elevations, the first (top most in the model, left most column in the spreadsheet) material is required to have a structure, or elevation file in the box labeled Top Elevation File. The remainder of materials require only a bottom structure or thickness file. **All materials must be defined the same way, bottom elevations, or thickness.** To toggle between elevations and thickness files, double-click the left-most spreadsheet cell, **fourth row down.** The label will change "Bot Elevation File" and "Thickness".

Once the spreadsheet is complete, select the File pulldown, Save and Exit option. **Be careful, as CLOSING THE SCREEN WITH THE X IN THE UPPER RIGHT CORNER OF THE WINDOW, IS EQUIVALENT TO CANCELING THE ENTRY.**

**Options:**

- **Using Scalar Numbers:** If a grid or triangulation file does not exist, and an assume number is to be used, type the number in place of a file. **Note:** If a file exists with the same name as the number, the file will be used. For example entering a scalar of 123, when a file 123.GRD exists, will cause the program to use the file.

- **Grids or Triangulations:** Clicking the option Grids, or Triangulations will limit the list of possible files when selecting a file. Also, if the file selected is a grid file (.GRD extension) and the Grids option is selected, the extension of the file is not shown in the spreadsheet cell. The same holds true for triangulation files.
• **Ultimate Bottom:** If a Grid or Triangulation file exists that defined the bottom of mining, enter the file in the Ultimate Bottom box (double-click for a file list.) All blocks or portions of blocks falling below this bottom will be trimmed to that file, or discarded completely as needed.

• **Common Folder For Files:** Each Pit may refer to a different folder on the hard disk. This folder can be set with the Set button to the right of the 'Common Folder For Files:' label. This will be the default folder to search in file selection. If selected files are in that folder, the folder path will be removed in the spreadsheet display. If a file is selected outside that path, then the full name, including the path will appear. Changing the common folder will change all files to reference that path, if the files exist.

• **Key:** Volumes and Weights are split into two categories, Key and Non-Key. Totals for each material are given during block mining, as well as total weighted values for Key and Non-Key.

• **Density:** All materials are reported as volumes and converted to weights by either a density grid, or scalar. The weights are then used to report weighted averages of the qualities. A zero is allowed, but discouraged to properly weight averages. If no values are available, use the same scalar for each material. The number 1 is acceptable for such a situation.

• **Using A Carlson Precalc File:** A Carlson Precalc file may be used to fill in the spreadsheet. The behavior of the option differs depending on the status. If no materials or qualities have been defined (a new model), all material (strata) in the precalc file will be added. The user may pick all or some of the attribute (qualities) in the file to use in the block model. If materials and/or qualities have been defined (a new model), all materials (strata) and attributes (qualities) in the precalc file that match the names in the block model will be examined by the software. Spreadsheet cells that are blank and match the precalc file, will be filled in.

• **AutoFill Right:** After at least one material has been added to the model, the AutoFill Right button will appear. After filling in file names for the first strata, the AutoFill Right button may be useful. If all files for each strata are named similarly, the software can make some intelligent selections of files. For example see the following example:

![Model Specification For Pit DEFAULT](image)

The model has three strata, ls1, ls2, and ls3. The file name values are entered for ls1, but are blank for ls2 and ls3. The common folder path is set to X:\425-002\model\BATDORF. By placing the cursor in any cell under the ls1 heading, and pressing the AutoFill Right button, the software looks for files that have the 'ls2' where the 'ls1' occurs in the previous files. It repeats the process for each blank cell, under each named strata. Because the files existed in folder X:\425-002\model\BATDORF for this example, the screen now appears as shown below. This example shows the benefit of using consistent naming practices in Carlson.
6. Copying Files From Other Pits

After the model is set up in the first pit, the basics are complete. However, additional pits still need to have reference to appropriate files for those pits. If model files are being entered for a pit other than the first pit, another option is available under the File pulldown menu. It will appear as "Copy From Pit <NAME>" where <NAME> is the name of the first pit in your project. If this button is picked, an exact duplicate is made of the default (first) pit.

If the names of the files are the same as the first pit, but the folder they are in is different, simply copy the first pit files, and change the Common File Folder. If the files exist, they will redisplay. Files that do not exist are shown in red. You may also copy files into the first pit from another block model file if the current model file is newly created. Select the option under the File pulldown, select the database, and the files are filled in.

7. Laying Out Blocks

Block outlines are generally simple a series of boundary lines stacked one on top of the other throughout the reserve. Generally the block height represents a single bench elevation used in the mining. For example, look at the example below of a pit with a ramp, created with the Carlson Process Fill/Cut command, and rendered with the 3D Viewer.
If we look at a plan view of the pit, contoured at the bench elevations, we would see something like the following:

The contour lines at each bench elevation become the limit of blocks we are going to create. Blocks outside those lines are not accessible, and do not require storage in the block model. The software allows each level of stacked blocks to have its own limiting boundary. In the case of a single bench mine, a single boundary line is all that is required.

8. Block Bench Entry:
Set the appropriate pit on the main menu, and press the Layout Benches And Blocks Button. The screen will appear similar to:

The buttons in the top left corner control the zoom level and view by Zooming Out, In, Previous, Extents, Window, and Pan, respectively.

Block definition is divided into two portions. The first option is Definition of Block Base Elevations. The second option is the Definition of Block Boundaries.

Block Elevation boundaries (Benches) can be accomplished by two methods:

**Manual Entry Block Base Elevations**

**Step 1:**
Enter low, high, and spacing (step) values of benches in the upper right boxes. Pressing the Add button places the values in the frame labeled Bench Base Elevations To Use. For example, suppose the bottom of the pits were at elevation 1240 with bench elevations of 40 units extending upwards to the highest bench of 1520. With those values in the appropriate boxes, pressing the Add button results in:
The list of elevations now shows in the Bench Base Elevations To Use frame, sorted highest to lowest. Each has a color attached to help differentiate the boundaries. To enter a single elevation into the list, put the single elevation value in the Hi, and Lo box, with a Step = 1, and press the Add button. As many as required may be entered. The values do NOT need to be equally spaced.

**Step 2:**

Once all the elevations are set for the benches, each must be assigned a limiting boundary line. Click the mouse on one of the elevations. The elevation will turn bold. In the example below, elevation 1520 was selected:

The bottom button in the Bench Base Elevations frame now says "Set 1520 Inclusion Perimeter." Press that button to select the boundary line in AutoCAD. Once selected, the screen will reappear. In this case the outer-most boundary
line from the contours shown earlier was selected and the screen returns:

Repeat Step 2 for Each boundary line until the screen appears similar to:

Note that the selected elevation in the list highlights the appropriate boundary line on the drawing.

**Automatic Entry of Block Base Elevations**

If the limiting lines for each bench are already drawn on a single layer in AutoCAD, and are 3D Polylines, or 2D Polylines with elevations (as drawn by the Process Fill/Cut command, or Contouring routines in Carlson), the software can use them automatically. The button labeled Select Bench Elevs By Layer In DWG accomplishes this task. Pressing that button switches to the AutoCAD drawing and prompts the user to select a single entity. Note: All entities on that AutoCAD layer are examined so the boundary lines should reside on a layer to themselves (no other polylines on the layer). When the selection is made, the following prompt will occur:
Selecting Yes causes all elevations to be added to the list automatically, and the polylines attached. Choosing No causes only the elevations to be added to the list (no boundary lines.) In this case, Yes was selected. Press the Zoom Extents button to see the boundaries.

**Definition of Block Boundaries**

**Regular Blocks**

Block boundaries are defined in with the options in the lower right box on the page. The simplest option is the button "Regular Block From Starting Point And Angle." The option creates rectangular shaped block boundaries based on a selected orientation. When this option is selected, the screen switches to AutoCAD.

- The program prompts: Select One Corner Of A Block, - Inside AutoCAD, select the corner.
- The next prompt is: Select Angle Along Block Face - Use AutoCAD to select the orientation.

The pit layout screen reappears prompting for the length and width of the block faces. The software then draws the blocks on the screen that could possibly be present. The following screen is an example where square blocks were selected:

As the screen above indicates, some of the blocks are outside the perimeter, some are inside, and some are partially in, partially out. This shows the need for some method to decide whether the block is included in the model or not.

The box labeled "Minimum Block % To Include In Calcs" allows the user to enter a threshold for using the block or not. A value of 100 would include only blocks completely inside the perimeter(s) of the elevation benches while a value of 1 would include any block inside or touching the perimeters. Regardless of the value entered, the percentage of each block contained inside the perimeter is stored along with the block model. When the blocks are mined, the percentage is applied to the recoverable volumes and weight.

**Arbitrary Blocks**

The following is the perimeter of the example Inside Of AutoCAD. It has a series of interior lines drawn at pit boundaries (blue ends indicate the grips from selection in the drawing):
The arbitrary block algorithm uses a polygon processor logic to create the polygon block boundaries from primitive lines and polylines.

- **Option1: From Selection Of Lines And Polylines** - This option allows a selection set manually made in AutoCAD.
- **Option2: From Selection Of Lines And Polylines On A Layer** - This option allows a selection set made by selecting a single entity in AutoCAD. The software then gathers all entities on that layer to use for the selection set.

Regardless of the option, the software starts with the prompt:

Coordinate snap is a method to force the selected line segments to intersect, or trim as needed automatically. It helps clean up loosely drawn geometry to create perfectly matched polygon edges. The following demonstrates the affects of coordinate snap:
Any small number is acceptable, depending on the integrity of the primitives selected. If gaps and overhangs occur in the drawing larger than the entered snap, the user is warned. Red circles are also drawn in the AutoCAD drawing where the errors exist to aid in correcting the primitives. Assuming Option 1 is selected, and the lines shown in the last diagram are selected in AutoCAD, the screen will return as:

Depending on the complexity of the geometry, a small amount of time may pass as the software build the polygons.

**Saving The Block Boundaries And Elevation Limits:**
Process To File, and Process And Append To File accomplish the same task, building the block model. Process To File erases any existing definitions of blocks for this pit, rewriting them completely. The Process and Append leaves existing blocks, adding the new ones described in the page. A progress bar appears on the screen to indicate progress. The process run time is completely dependent on the total number of block, total number of elevations
(benches), and the complexity of the geometry. This process of building blocks is required for each pit separately.

9. Building The Model

This section is fully automatic after setting the active pit and pressing the Build Model on the main screen. Optionally, you may use the File pulldown menu >Build All Pit Models. This option runs the model for each pit, one at a time. The routine interpolates each structure and quality file in the model at the common resolution, applies them to each block, and summarizes the block in the model. It is the most computer intensive section of the block model program.

All summaries are kept in the model file itself. For example, if the model is name Test, the summaries are all in the disk file Test.mdb The software also creates a series of model files for each pit. If we had three pits defined, three additional files would be made: Test1.mdl, Test2.mdl, and Test3.mdl. These files can be quite large depending on the detail of the user selections. However, they are quite useful in analyzing the model (next section.) The software uses the files to instantly re-analyze blocks, should you choose to split a block on elevation boundaries.

Updating A Model With New Information

As is generally the case, continuing mining activities yield more and more information. Should additional holes be drilled, or pit samples added to the Carlson model, the user may choose to rebuild the grid or TIN files used by the model. If that is the case, and the changes warrant updating the blocks, building the model is a simple as pressing the Build Model button.

However, this is true only if the model names are unchanged, and the block layouts have not changed. Those changes require re-entry of the applicable data before building the model.

10. Analysis

After the model is built, press the Analyze Model button on the main page. The screen appears similar to this:

```
Using The Screen

- Placing the mouse on the small corner at the lower of the drawing on the left, pressing the left mouse button, and holding it down, sizes the drawing window.
- Placing the mouse between the two spreadsheets shown by blue line above (not on the actual screen), pressing the left mouse button, and holding it down and moving the mouse up-down, sizes the spreadsheet windows heights.
```
• Placing the mouse between at the left of the top spreadsheet shown by blue green above (not on the ac-
tual screen), pressing the left mouse button, and holding it down and moving the mouse left-right, sizes the
spreadsheet windows widths.
• The drawing may overlap the spreadsheet or vice versa. Clicking the mouse in either one cause that section to
be on top.
• The spreadsheets have control bars to slide up-down or right-left in the data.
• Spreadsheet column widths are adjusted by holding down the mouse on the line between columns in the
header section of the sheet and dragging. All columns in both sheets reflect the new column width.

Basic Concepts:

• Blocks are selected in the drawing area.
• Blocks are selected from the top down.
• Selected blocks go into the temporary work area for viewing of data.
• Once satisfied with the temporary data, the data is moved into the current group.
• Groups are simply user defined mining areas of multiple blocks.

Selecting Blocks (Blocks are selected in multiple ways):

• Place the mouse in side the block and left click.
• Hold down the shift key, and the mouse left button. Move the mouse over block. Blocks are selected as the
mouse touches them.
• Use the Select Pulldown > Fence. Draw a polyline on the drawing by subsequent clicks of the mouse. Press
the End Select button after the last point. All blocks touching the polyline are selected.
• Use the Select Pulldown > Window Poly. Draw a polyline on the drawing by subsequent clicks of the mouse.
Press the End Select button after the last point. The polyline is closed automatically. All blocks inside the
polygon are selected.
• Use the Select Pulldown > Crossing Poly. Draw a polyline on the drawing by subsequent clicks of the mouse.
Press the End Select button after the last point. The polyline is closed automatically. All blocks inside or
touching the polygon are selected.

De-Selecting Blocks:

• Place the mouse in side the block, hold down the Ctrl key and click.
• Hold down the Ctrl key, and the mouse left button. Move the mouse over block. Blocks are de-selected as the
mouse touches them.
• Click the mouse in any cell in the temporary work area spreadsheet. Click the Del Block Button. The block
represented by the column of the active cell is removed.

Previewing The Block Data Before Selection:

If a single block is selected with the right mouse key, a detail of the block is displayed as shown here:
As the mouse is moved throughout the block, the detail data is shown in the spreadsheet in the lower left. That data reflect the values where the mouse lays in the block on the drawing. The total block data is shown in the right spreadsheet. The Exit button cancels the selection, and the OK button adds the block to the temporary list. (Optionally the block seams to mine, or the elevation to mine to is set as explained in later sections.)

**Real-Time Block Data Feedback:**
As the mouse is moved the text under the drawing gives basic feedback on the block. The data shows the bottom elevation of the topmost un-mined block the mouse is over. It also shows the group of the last mining that occurred in the block above.

**Optional Real-Time Block Data Feedback:**
By Selecting the Drawing pulldown > Block Realtime On/Off, a small chart appears under the drawing showing the breakdown of the block the mouse is over such as. The values change as the mouse is moved.
Locating Selected Blocks:
After blocks are selected, they may seem difficult to locate. So, the spreadsheet has some special actions that allow you to find a block on the drawing.

- **Option 1:** Place the cursor in row 1 of any block in either spreadsheet. Right-click the mouse. The drawing will shift so that the particular block is centered on the screen.
- **Option 2:** Place the cursor in any row other than 1 of any block in either spreadsheet. Right-click the mouse. The drawing will highlight the block similar to:

The highlight remains on until another block is selected.
Changing Analysis Screen Appearance

- **Manipulating The Spreadsheet Data Visibility:** By default the spreadsheets show all data for all seams. In addition, the total Key data is shown at the top of the spreadsheet, and the total Non-Key data is at the bottom. The left column in the spreadsheet is the total of all blocks in the spreadsheet. The following example shows the layout:

```
<table>
<thead>
<tr>
<th>Total</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block</td>
<td>1400</td>
<td>1400</td>
<td>1400</td>
<td>1400</td>
<td>1400</td>
<td>1400</td>
</tr>
<tr>
<td>Key</td>
<td>1310</td>
<td>159</td>
<td>298</td>
<td>64</td>
<td>119</td>
<td>277</td>
</tr>
<tr>
<td>Key</td>
<td>2351</td>
<td>416</td>
<td>625</td>
<td>133</td>
<td>245</td>
<td>573</td>
</tr>
<tr>
<td>Key</td>
<td>66.1</td>
<td>56.2</td>
<td>64.4</td>
<td>66.0</td>
<td>56.6</td>
<td>56.6</td>
</tr>
<tr>
<td>Key</td>
<td>4.4</td>
<td>5.3</td>
<td>5.8</td>
<td>3.3</td>
<td>3.3</td>
<td>3.3</td>
</tr>
<tr>
<td>Key</td>
<td>2.8</td>
<td>2.8</td>
<td>2.8</td>
<td>2.8</td>
<td>2.8</td>
<td>2.8</td>
</tr>
<tr>
<td>Key</td>
<td>10.6</td>
<td>10.6</td>
<td>10.6</td>
<td>10.6</td>
<td>10.6</td>
<td>10.6</td>
</tr>
<tr>
<td>Waste</td>
<td>1848</td>
<td>300</td>
<td>255</td>
<td>426</td>
<td>251</td>
<td>316</td>
</tr>
<tr>
<td>Waste</td>
<td>3012</td>
<td>629</td>
<td>478</td>
<td>629</td>
<td>405</td>
<td>911</td>
</tr>
<tr>
<td>Waste</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Waste</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Waste</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>Waste</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
</tbody>
</table>
```

The data visibility can be set with the pulldown menu View > Set Quality Visibility. The following grid appears to turn particular data on/off:

![Set Visibilities](image)

- **Lock the Key Data Display:** The Key data can be prevented from scrolling in the spreadsheet with the pulldown menu View > Freeze Key Info.
- **Turning Pit Areas On/Off From Visibility:** The pulldown menu View will contain the name of each Pit. Clicking on the name of each pit will turn the areas on/off in the drawing.
- **Colorizing Blocks:** Blocks can be colored in various ways using the pulldown Menu Drawing > Colorize >
- **By Bench:** Each level of mining is assigned a new color. A legend appears on the right edge of the drawing.
**Best to Worst:** This section shows suitability of mining on a graded scale. The following menu appears:

The left side of the screen allows you to set the number of colors, and the red, green, blue components of the good, bad, and mid-range colors. The right side of the screen allows selection of the qualities to consider. Turning on the checkbox activates that quality in the weighting. The Weight For This Quality box allows the user to weight a particular quality greater or lower than others in the analysis. The value has no application for a single quality. The Hi Numbers Are Good check box allows the user to specify whether the best value of the quality is a high or low number. The following is an example of the result with 2 qualities, equally weighted. Gray blocks are areas with no quality information to weight.
• **By Qualities:** This section shows colors by a primary and optionally a secondary quality. A menu will appear similar to:

The primary quality is selected in the top box. In this case, MGO was selected. Then a series of breaks was entered into the top spreadsheet. The example shows 3, 4, 5, and 9999999. This would equate to zones of: 0-3, 3-4, 4-5, 5 and up. When the cursor is on a particular row, slide the Red, Green And Blue sliders to obtain a color. Double click in the preview color box under the sliders to set that color to that row.

The secondary quality will be used (if included) to set shades of colors between the two primary colors ranges. Set the applicable seams (materials or strata) and press OK. Each block will be displayed in its own color, for the
weighted total of the selected materials.

- **Additional Plan Views:** Additional plan view windows can be opened using the pulldown menu Drawing > New Plan View. The windows are designed to show a single mining elevation level (bench) at a time. The windows float. That is, they disappear behind the main form when it is active, but remain in the task bar and can be brought to the top by clicking there. The bench elevation to show is set in the pulldown at the top. Below is an example where one window shows the blocks at elevation 1440, and the other at 1360. The windows do not update automatically with mining changes (a speed consideration). Use the R button to refresh them.

- **Section View:** A section view window can be opened using the pulldown menu Drawing > Section View. The window is designed to show a single east-west section view. The window floats like the additional plan views. Once the Section view is activated, click the Section button above the main drawing. Click any point on the drawing. Return to the Section view and zoom extents.
Limiting Mining In Blocks:

- **Limiting the Mining of the Block By Elevation:** The second row of the temporary spreadsheet is labeled "Mine To Elev" By default, when a block is picked, this value is set to the bottom elevation of the block. If the value is changed to a value higher than the bottom, the block is reanalyzed and the data updated. Setting it to a value lower than the block has the same affect as mining the entire block.

- **Limiting the Mining of the Block By Material:** Each material (strata) has a check box row in the spreadsheet. If that box is turned off, and the active cell changed, all materials below the one in question are turned off, the block is reanalyzed and the data updated. Similarly, if the cell is turned on, all materials above it are turned on, the block is reanalyzed and the data updated.

- **Limiting the Mining of the Block By Material On the Entire Temporary Spreadsheet:** Double-clicking the left-most (gray) column in any row with check marks, changes all blocks in the temporary spreadsheet at once.

- **Limiting the Mining of the Block By Material Before Selecting:** To mark the strata to be mined before the blocks are selected, use the menu File pulldown, >Set Lowest Mined Strata. Set the lowest strata to mine and press OK. As the blocks are selected, the materials below the strata selected are marked as unmined.

Note: When a block is partially mined, and added to a group, the remainder of the block is still present for selection in the drawing. For example, if we mine two block, one to elevation 1460, and one through the 'Waste' seam. The drawing would appear as:
This text is only visible when the drawing is zoomed to a fairly tight scale. The next time we choose that block, the material mined previously will not be shown, because it has already been removed from the block.

- **Groups:** Groups are named collections of mined blocks. One group is active at a time. The name of the group active is in bold text in the lower spreadsheet. The button about the temporary spreadsheet also will be labeled "Add To Group &lt;Name&gt;" Where name is the group that the temporary blocks will be added to when pressed. To edit the group list, either use the pulldown menu Groups &gt; Add New Group, or simply double-click the name of the group in the lower spreadsheet. A screen will appear:

![Groups Screen](image)

Double-click any title to make the group the current group, and to edit its name in the lower box, or press the new button to add a new group and name it. When the OK button is pressed, the current group data is displayed. When a group is displayed, the drawing zooms to the group limits, and draws a yellow boundary line around the group such as:
• **Editing Block Data:** If a cell is selected in the block, and the Del Block button is pressed, the block will be deleted from the group. The Clear Group button will delete all blocks.

• **Send To Excel:** This button will dump the current group data to Microsoft Excel.

• **Undoing Actions:** Each time a series of blocks is moved from the temporary spreadsheet to a group, a record of the transaction is made in the database. Using the pulldown menu Undo/Erase > Undo command will undo the last transaction record in the database. Using the pulldown menu Undo/Erase > Redo Last Undo will redo what was just undone. However, this is only usable once between transactions. Using the pulldown menu Undo/Erase > Erase Back To A Block # allows you to remove blocks from the mine plan back to the point a single block was added to a group. The block numbers are labeled in the top row of the group spreadsheet.

• **Analysis Reports:** After a series or groups are mined, the summary report can show the totals of each group, and an overall total. Use the pulldown menu Reports > Summary Page to get the totals. An example is shown here:
The check box at the top of each column includes or excludes the column from the total column. (The box must be changed and the cell exited before the totals update). The data can also be exported to Microsoft Excel with the Send to Excel option.

**Pulldown Menu Location:** Block Model  
**Keyboard Command:** csbm

## Case Studies

### Case Study #1: Techniques of Geological Compositing

Two Types of Compositing are described here. (1) Single Seam or Ore Body compositing where the seam has been sampled at various intervals, and (2) Combinations of Several Seams Separated by Interburden.

**1) Single Seam or Ore Body**

Large ore deposits such as limestone and thick beds of coal are often sampled at multiple points within the single ore body or bed. For long-range planning and reserve estimates, it is often desired to obtain the composite quality for the entire mineral deposit within an inclusion perimeter. For short-range planning, the mine engineer needs to know what quality will be obtained in a particular vertical segment of the ore body or seam, also within a defined perimeter.

**Entire Seam Composites** In the first example, a body of ore has been sampled at 3 to 4 points vertically, as seen in the geologic columns. Note in the geologic columns (generated with Draw Geologic Column) that all the ORE has been assigned bed "A". This will "lump" the various ore samples into one "bed". If the bed name is not assigned when the holes are drawn, then this can be accomplished by the commands "Assign Bed Names" or "Fill in Bed Names". Then the command Selected Strata Quantities will produce this report (showing composite A tons) when the A Key strata is chosen singly and the inclusion perimeter is selected. Compositing of the single A bed is automatic.

Note: The program will not composite qualities for a strata name that is repeated, unless there is a bed name grouping them together.
The command Selected Strata Quantities brings up this screen to select the strata or bed to analyze.

Follow these prompts to get the report screen.

CHQUAN2
Select drillholes, channel samples and strata polylines.
Select objects: Specify opposite corner: 3 found
Select objects: ENTER
Reading drillhole 3
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Processing only strata with beds.
Select the Inclusion perimeter polylines or ENTER for none.
Select objects: 1 found
Select objects: ENTER
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: ENTER
Choose modeling method [<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq/ABOS]? TRI
Apply global trend to strata extrapolation [Yes/<No>]? N
Use Triangulation Subdivision [Yes/<No>]? N
Pre-processing grid cells ...
Ignore zero attributes [<Yes>/No]? Y
Create composite quantities [Yes/<No>]? N
Assigning grid values > 2700
Processing cells ...
Enter strata A_KEY density in lbs/ft^3 <0.000>: 80
A_KEY Volume: 139868398.5 C.F., 5180311.1 C.Y., Avg Thickness: 27.53
A_KEY Area: 5080947.3 S.F., 116.6425 Acres
A_KEY Tons: 5594735.9 at Density: 80.00
Calculate qualities from strata A_KEY values [<Yes>/No]? y
Assigning grid values > 2700
Processing cells ...
BTU of A_KEY: 8264.084
Assigning grid values > 2700
Processing cells ...
MOISTURE of A_KEY: 30.510
Press ENTER to continue.

Vertical Composite Zones
In the next example, a vertical zone of ore has been defined as the upper part of the ore body or "A" bed from 4130 elevation and up. The "floor" of the vertical cut in this case is flat, following the 4130 elevation. This might correspond to a mine plan where the base of the first of two cuts is designed to hit elevation 4130 within the entire pit. The technique required is to divide bed A into two beds. This is done by the command "Split Bed" within Strata/Bed Utilities under Drillhole. The prompting is as follows:

Command: splitbed
Split strata method [<Elevation>/Grid/Thickness]? E

Chapter 14. Geology Module
Select the Drillholes for bed split. Select the holes
Select objects: Specify opposite corner: 3 found
Enter name of the bed to split: A
Rename bed or assign key/non-key status [Name]/[Status]? Name
Enter new name for the upper part of the bed: A Upper
Enter new name for the lower part of the bed: A Lower
Enter a split elevation: 4130

This shows a drillhole before splitting the A seam into an A Upper and A Lower.

Here is the same drillhole, viewed within "Edit Drillhole" after the command "Split Bed". Notice the new Bed Names, A Upper and A Lower.
The result is a new base of A Upper seam. It is important to note that the quality characteristics of the original ore zone have been applied identically to the new ore zones that have been renamed to A Upper and A Lower. The rest of the ore zone, the lower 12.5 feet, has become part of A Lower. If a drillhole does not reach as low as 4130 elevation, then all the ore remains in the A Upper bed and is unaffected. Conversely, if the ore never exceeds elevation 4130 in a particular drillhole, then it is assigned bed A Lower for all the ore sample points. Here is a Fence Diagram showing the two divisions of the bed, at elevation 4130.

Now the command "Selected Strata Quantities" can be run. Ironically, you don't select the "composite" option.
because you want to calculate the A Upper and the A Lower beds distinctly. You select them one at a time from the
dialog box. This leads to the result shown here in the report. Adding the tons calculated here: 3292460 + 2351700 = 5644160 calculated above, when the bed was just A. This is a good check to make sure the quantities match.

Split Bed by Grid File

In the previous example, we chose to split the bed by elevation. If, by contrast, the goal was to leave 5-feet of lower
ore in place to be removed by different equipment, then the vertical demarcation is not a fixed elevation but a grid
file defined as base of ore plus 5 feet. This grid file is made by using "Make Strata Grid Files" to make the base of
ore, then using Grid File Utilities (in the DTM or StrataCalc menu) you would add a value of 5-feet and re-save the
grid file as Oreplus5.grd or some such name. This new file would be used to delineate the split elevation between
the A Upper and A Lower beds.

Advanced Mine Module Techniques

In the above example, the command "Selected Strata Quantities" was used. This is an "on-the-fly" selection approach,
where the drillholes are selected each time the command is run. It does not take advantage of stored grid files in the
Precalculated Grids file (.PRE), which is the essence of the Advanced Mine Module. To apply the above procedures
to the Advanced Mine Module, follow this sequence:

2. Make grid files for the surface, the top of Bed A Upper, the base of Bed A Upper and the base of Bed A Lower.
3. Enter these files in appropriate order (A Upper first, then A Lower) as a stored "Pre-Calc" grid set, using the
   command "Define Pre-Calc Grids" under the Drillhole pulldown.
Then run Surface Mine Reserves, selecting Pre-Calc Grids as the modeling method. You will obtain the same quantities for each bed as reported from the command "Selected Strata Quantities".

The advantage of setting up grid files is that multiple, prenamed pits can be run within Surface Mine Reserves, and the reporting can be formatted and expanded upon at the user's discretion, even dumped to Excel and Access. The various options within Surface Mine Reserves can be fine-tuned, such as recovery percentage, density and dilution. Furthermore, "grand totals" are obtained where the qualities and volumes/tonnages of beds A Upper and Lower are composited back into the total reserve values. (Indeed, this is the exact procedure used for multiple seams with interburden.)
Shown here is a formatted report for the single inclusion polygon representing the pit in our example. Slight differences in values versus "Selected Strata Quantities" is a function of the difference in gridding locations and cell sizes. With stored "pre-calc" grids, quantities and qualities will be fully repeatable.

(2) Combinations of Several Seams Separated by Interburden

In the mining of stratified deposits it is very common to have several seams separated by interburden. Surface mines must consider the composite tonnage, composite strip ratio and composite quality in any reserve study or short-term mining plan. Two main issues come to mind—how deep to mine, and when to mine and remove interburden as if it
were Key. Let's look at a coal deposit example.

How Deep to Surface Mine
Strip ratios change as each lower seam is taken, and quantities of coal increase. The goal is to get as many lower seams as possible, but not so many that interburden thicknesses and strip ratios increase excessively, or quality degrades. Currently, about a 15:1 strip ratio approaches the maximum feasible ratio for cost-effective mining. Higher ratios do occur and will certainly occur if the market price of coal increases. Coals are said to "outcrop" at the surface, with "crop loss" referring to unmineable, "weathered" coal at the hillside edge. Usually the crop loss is around 12 to 15 feet measured vertically from the surface. It is often deeper in valleys or even small hillside ravines and "drains", due to accumulation of debris and erosion. On "points" or ridges, crop loss may be only 10 to 12 feet, particularly in hardrock conditions. The Surface Mine Reserves routine is designed for estimating reserves and includes a built-in crop loss parameter (measured vertically from the surface), appearing as "Min Depth to Use". Here is a graphic representing the crop loss on the side of a hill.

[Image of crop loss on a hillside]

A conservative engineer or geologist would enter 15 feet to obtain a "low-ball" estimate. Someone looking aggressively for all the coal they could possibly obtain might enter 10 or 12 feet for the vertical crop loss. Be aware that with steep 1.5:1 hillside slopes, a 10' vertical crop loss translates to 15' measured horizontally from the hillside. In 3:1, gently sloping terrain, a 10' vertical crop loss translates to 30' measured horizontally from the hillside. If the natural terrain slopes on the order to 2:1 to 3:1 or more, it is reasonable to use a lower vertical crop loss value for "Min Depth to Use". The value used is strictly a judgment call and is ideally based on observations at the mine. There is no option to have a variable crop loss. That is best handled by defining a "Strata Limit Polyline". See the "OutCrops and SubCrops" case study. In many regions, shallow coals will "subcrop" as they hit an alluvial deposit or as it nears the surface and is decomposed due to oxidation and weathering.

Another Example: Getting Composite Qualities
The Surface Mine Reserves command automatically computes composite qualities and strip ratios on all Key strata, providing "Calculate Strata Qualities" is selected in the dialog box (dialog shown earlier above). The low SULFUR and BTU values for OB and IB are not included in the composite quality for SULFUR and BTU. This is because OB and IB are not defined as KEY. When C1 and C2 are imported or placed in the drawing, they are defined as KEY strata. Alternately, the KEY designation can be assigned and changed using the command "Define Strata". Shown is a drillhole example of this dataset, and the composite KEY quality report.
By contrast, composite qualities can also be computed using the command "Selected Strata Quantities", but this routine will composite any selected strata, key or non-key. In our example, if all 4 beds are selected, the composite BTU is only 1245. All of the above calculations were based on screen-selection of the drillholes (not grid files), and use of Triangulation modeling. (Sulfur was not entered for Nonkey beds).
Partings: When to Mine and When to Waste

Drillholes 8 and 10 below have 2.5 and 1.8 feet of interburden, respectively, between coals C1 and C2. It makes sense to take the thin interburden with the coals, even though this will dilute some qualities (and maybe improve others). Surface Mine Reserves has an option called "Min Minable Parting Thickness" designed specifically for this purpose. The effect on qualities is also shown below. This result is obtained automatically by designating 2.0 feet as the "minimum minable parting thickness", meaning that any lesser thickness will not be separated as waste but will be included as coal.
To obtain interburden qualities and to factor them into the composite quality, it was critical that qualities be associated with non-key strata. This is accomplished within the command "Define Drillhole" or a setting on the main Surface Mine Reserves screen for Fixed NonKey Qualities.

In our example, the interburden had a density set at 150 within Define Strata, and had BTU values in the 1000 range, and sulfur in the 0.5 range. The net effect of including the thin interburden was to improve sulfur and degrade BTU. If sulfur under 1.0% is the more critical value in meeting quality requirements, and less BTU is satisfactory, then the user could accept thicker interburden. Compare these quality values with the ones calculated above and see how the SULFUR is lower and the BTU is also lower, but still within spec. Just try several reserve runs to see what the parting thickness cut off can be.

Case Study #2: Outcrop and Subcrop Modeling

This tutorial steps through examples of how to handle outcrop and subcrop conditions on several examples involving ridge top mines as well as sub-cropping reserves. Accurately locating the crop is one of the first things the planner needs for laying out a mine. Carlson automatically detects the location of the crop within the Surface Mine Reserves command. Volumes will never be calculated from above the ground surface. The advantage of the Draw Outcrop routine is that it allows the user to witness where the program is interpreting outcrops and subcrops. It is also useful in establishing a starting perimeter for pit layout. Outcrops are automatically calculated and drawn using Draw Outcrop command under StrataCalc on the fly directly from the drillhole data, or from pre-calculated grids.

For Generating Outcrops Directly from Drillholes ("On the Fly")

- Surface Topography Grid, PreCalc file or Contours
For Generating Subcrops

- Drillholes on the screen
- Surface Topography Grid or Contours
- Drillholes on the screen
- Thickness Grid for Unconsolidated or Weathered Strata just below the surface

![Outcrop Settings](image)

**Outcrop Procedure**

Select Draw Outcrop in the StrataCalc menu. Fill in the Outcrop Settings dialog box. The user can specify the source for surface topography (grid file or screen selection) and what layer to store the outcrop in when it is drawn. The user normally will use the settings as shown in the dialog box below with one exception. The offset distance could be set to 0.1 to 1.0 ft to reduce the vertices in the outcrop when drawn. Otherwise, the polyline for the outcrop will contain an unnecessarily large number of points.

**Command:** `outcrop`

**Select surface entities & at least 3 drillholes**

**Select objects:** Specify opposite corner: 111 found

**Use drillhole surface elevations in surface model [Yes/<No>]?** enter Y if they match the contours, otherwise N

**Reading points ... 79695**

**Ignored 562 points with zero elevation.**

**Ignored 36 duplicate points.**

**Intersections found 80377**

**Pass> 10 Null Z values left> 0**

**Finding splits ...**

**Finding pinch out ...**

**Calculating seam stacking ...**

**Output grids for strata and surface [Yes/<No>]?** enter N; the files may be saved out for other uses. No is the typical response.

**Choose modeling method [Triangulation]/Inverse dist/Kriging/Polynomial/LeastSq]**?

**Apply global trend to strata extrapolation [Yes/<No>]?** enter Y

**Use Triangulation Subdivision [Yes/<No>]?** enter N

**Triangulating points ... 5**

**Assigning grid values> 98400**

**Pass> 282 Null Z values left> 0**

**Contouring elevation 0.0**
**Inserted 348 contour vertices.** Complete the Make Grid File dialog box. The user may select the total number of rows and columns or the grid spacing pattern option. The program creates the grids "on the fly" from the drillhole data.

![Make 3D Grid File dialog box](image)

Select the preferred method. Once the gridding method is selected the Choose Strata dialog box appears. Choose the strata to process. Each strata can be gridded using independent gridding algorithms. If Inverse Distance or Least Squares was selected as the gridding method, when the strata is selected, the user is prompted for the power to be used in the algorithm. Once the power is entered, assuming Inverse Distance or Least Squares is the selected method, the user is prompted for other strata to be processed. The user can select any number of strata to be processed by holding down the CTRL or SHIFT buttons.

![Choose Strata dialog box](image)

Outcrop lines are produced on elevation zero. To raise the outcrop to the surface, use the command 2D to 3D Polyline by Surface Model command under 3D Data in the Carlson Civil. This uses the surface model as the basis for assigning elevation to the outcrop polyline.
Making Fence Diagrams
As a way to verify the location of the outcrop or make a graphic presentation, a fence diagram can be created using the Fence Diagram command under StrataCalc. Fence diagrams are useful for presenting geologic data as well as verifying the proper location of seams and their burden. Shown below is a fence diagram taken from the line drawn from west to east through the outcrops on the hill.

Fence Diagram Procedure and Prompting:

Command: fence
Select polyline to pull fence diagram from: Pick the polyline to get the fence from
Use drillhole surface elevations in surface model [Yes/<No>]? N
Select surface entities and at least 3 drillholes. Select the drillholes and surface contours
Select objects: Specify opposite corner: 112 found
Reading drillhole 5
Finding splits ...
Finding pinch out ...
Calculating seam stacking ...
Ignore zero elevations [<Yes>/No]? Y
Reading points ... 79695
Choose modeling method [<Triangulation>/Inverse dist/Kriging/Polynomial/LeastSq]? I
Use inverse distance to which power [First/<Second>/Third/Other]? S
Use elliptical inverse distance [Yes/<No>]?
Calculating grid by inverse distances 98456...
Bottom elevation of grid <1650.00>: 1400
Pick the lower left corner for the diagram: Pick an open area in the drawing for the lower left corner of the diagram.
Layer Settings button can be used to set layers for the different components of the fence diagram.

Using Surface Reserves to Check the Outcrop Volumes
To prove that Carlson honors the outcrop in its calculations, layout a rectangular polygon that overlaps the outcrop area. If Surface Mine Reserves recognizes the seam crop, then the area of the seam will be less than the area of the perimeter, and the upper seam crop area will be less than the lower seam area. It calculates reserve areas and handles outcrops automatically. Higher surfaces (the topography in this case) are the limiting factors. Volumes will never be calculated above the next surface up.
The area of the perimeter is shown as 3.371 Acres, some of it within the area of coal, and some outside. Run the Surface Mine Reserves command using the perimeter to get the tons and acres of coal. A typical report from the Surface Mine Reserves command under StrataCalc is shown below. Reports are user-defined in the Report Formatting dialog box.

As the report indicates, Carlson recognizes the limits imposed at the outcrop. It successfully truncates the seam at the outcrop and reports the included area between the crop and rectangle. Notice the C1 has less acres than the C2 because it crops out higher on the slope. The C2 shows 2.192 Acres compared to the full 3.371 Acres of the polygon. The Pit Acres are reported as an available option in the Formatter.

In topographic situations similar to the one shown in this example, for coal, the user will have to deduct from the mineable reserves for crop loss. Crop loss sometimes runs 10' to 15' vertically. The coal in this zone is usually oxidized to such an extent that the BTU is so low and the ash is so high, the coal cannot be sold for steam product, and chemistry is so poor that it cannot go for metallurgical product either. Oxidized coal is treated as overburden.

**Using Outcrops for Laying Out Pits**
In the example below, the outcrop was used to define the limits of the surface mining pits. The outcrop defined the limits of mining on each side of the pit. The direction of mining was input as part of the pit layout routine. The
example below shows the Pit Layout By Advance command executed on the closed polylines. First, create a close polyline of the outcrop/mine boundary. Use the command Draw-Boundary Polyline and pick inside the ridge/outcrop lines to get a new interior polyline. You can also use AutoCAD's BPOLY command. Then, draw a direction line down the ridge to assign direction. Pits will be cut perpendicular to this line.

**Pit Names, Labels, and Identify Pit Names**

Since the process of laying out pits using the Pit Layout By Advance option gives the pits a name, a discussion of naming and labeling procedure is helpful at this point. After the pits are drawn, there are two methods to draw the pit name labels. Go to Label Pit Polylines or Pit Label Formatter. Identify Pit Polylines allows the user to see the Pit Names when the labeling option was not selected.

**Subcrop Procedures**

Subcrops occur where the unconsolidated material (could be glacial till or a channel deposit) has eroded out the key seam below the surface. Subcrops differ from pinchouts, in that unlike pinchouts, which can occur anywhere below the surface, lower strata being eroded by the unconsolidated material cause subcrops. Unlike outcrops which can be created "on the fly" from drillhole data, subcrops are calculated from grids. To calculate subcrops, the user must
have the surface grid, thickness grid of the unconsolidated material, and bottom elevations of the strata to test for subcropping. In addition to the gridding algorithms, the user can specify strata limit polylines to override the natural mathematical interpretation of the data. When Carlson calculates the subcrop it starts from the surface and works down through the grids. If an upper grid has a lower elevation lower than that of a lower grid, the elevation of the upper grid is set to the elevation of the lower grid. This leads to a zero thickness in the lower grid, or a subcrop. Select the File option to begin calculating the subcrop. Carlson allows the user to calculate the subcrop from a pre-calculated grid or directly from the drillhole data.

This example was created by making strata grids from the drillholes. Put them in the PreCalc grids file and then generate a Fence Diagram. The outcrop coincides with the outcrop lines in plan view on the hill side. Notice how the glacial till is subcropping the upper coal seam and the parting.

**Strata Limit Polylines** Using the same example for the Subcrops above, we will now create Strata Limit Polylines for both the coal seams and the parting. They must be drawn in plan view, then named with Name Strata Limit Polylines. Strata Limit Polylines must be turned on under Configure, Mining Modules. There are options to use them, and to automatically select them. The orange lines are limit lines. The interior line is an Exclusion for the upper coal seam. The outer line is an Inclusion for the lower coal seam. Volumes will be calculated accordingly with Surface Mine Reserves.
Case Study #3: Techniques Of Gridding

Surface and Underground Reserves are the key routines for developing reserve estimates and qualities and for setting up equipment-based mine scheduling. Along with the Fence Diagram routine, Surface or Underground Reserves will calculate strata elevations and qualities using pre-calculated grids. These grids represent the "mine model". Working from the stored pre-calculated grids is one of the primary advantages of the Advanced Mine Module. Here we will study how to make the grids strategically to build in well-defined subcrops, outcrops, splits, correct strata thicknesses and qualities.

What is the "Pre-Calculated Grids" File?

The Pre-Calculated Grids File can either be an Elevation model, or a Thickness model. The elevation model consists of a grid model of the surface topography as the first and primary grid. Below the surface grid is the bottom elevation grid for each strata under modeled, placed top to bottom in the pre-calculated grids dialog box. As an option only, any number of quality attribute grids (covering such items as sulfur, ash, moisture, etc.) can be associated with the bottom elevation grid of a particular strata. If a strata is called C1, for example, the C1 name is associated with its bottom elevation grid file, and any attribute grid files to go with that seam. A Thickness PreCalc just contains thickness grids, no elevation grids. There is no surface topo grid file defined in a thickness model. Below are typical examples of both types of Pre-Calculated Grids (PreCalc) files.
When naming attributes such as Ash, BTU and Moisture, be sure to attach the attributes to a strata (in this case C1 and C2) which must match the exact spelling of the strata name containing the associated base elevation or thickness grid. Entries, however, are not case sensitive, and are converted to upper case automatically.

**Grid Cell Dimensions**

Drillholes at many mines are often drilled at a spacing of 500 feet or more, making small cell size unnecessary when modeling geologic aspects, especially quality attributes. As a rule of thumb, cell size should be 1/4 the average drillhole spacing between drillholes for most accurate modeling. With some minerals and ores such as quality controlled limestone and clay, drillholes are drilled as close as 50 feet apart. This would suggest the need for a 12.5-foot cell size or less. Surface topography, however, often demand the tightest cell size, because the topography can include steep cliffs, high stream banks and other abruptly changing features, that can be lost or smoothed if cell size is on the order of 100' to 200' spacing. Below are two examples of surfaces. The first surface has gently sloping terrain and widely-spaced contours. This has been gridded at 100'x100', as there is not any sharp features that need to be captured in the grid file. The second set of images shows an open pit with benches, spoil and roads. To accurately capture all of this detail, it is gridded at 10'x10'. It makes a much larger file, but does not smooth the surface, as a larger grid cell size would do. There is no limit, but try to keep the number of total cells in a grid file.
Cell Positions and Dimensions Should Match

Some routines in Carlson require that the grid position and cell size should be identical for all grid files in a PreCalc grid model set (Design Bench Pit is an example). This has also been a requirement, for example, in many Grid File Utilities, such as Merge Grid. To ensure that grids match position and dimension, make the first grid file, then make all additional grid files based on the position of the first grid file. To do this, you select option "F" when prompted: Use position from another file or pick grid position (<Pick>/File)? There are Grid File Utilities to modify grids, such as Change Position, Change Resolution and Match Dimensions.

In Surface and Underground Reserves calculated from a PreCalc, the grids do not need to match. It is common to have a surface topo grid file with a small cell size, such as 10x10. Then the structure grids for elevation or thickness could have a medium cell size, such as 50x50. Finally, quality attribute grids can have an even larger cell size, such as 200x200. This could be due to the fact that not every drillhole has quality sampled, so the spacing of quality holes is much greater than structure data holes, not needing a tight resolution.

Cell Dimensions Versus Number of Cells

Carlson defaults to 50x50 "number of cells" when first installed, meaning that in any grid window position, there will be 50 cells in the X-direction and 50 cells in the Y-direction, unless altered by the user. If the window is longer in the x-direction, then the cells will be longer in their X-dimension than in their Y-dimension, creating rectangular shaped grid cells. By contrast, the user can specify the cell dimension when making grids, leading to a variable number of cell, depending on the size of the grid window. It should be noted that the default itself can be set by the
This is done by selecting Configure, option Surface Settings, which provides the following dialog. Note that at the bottom of the dialog there is the option to set the number of cells or the dimension of the cells to any desired value.

Make Top of Strata Grids by Adding Thickness Grids to Bottom of Strata Grids

The elevation Pre-Calculated Grids File (another name for "the geologic model") is based on having grid files for the bottom and top of all key strata. If you have only the surface grid, and the bottom and top elevation of each Key strata, you are set up for most reserve and scheduling work. Of course, quality grids can be added, and NonKey elevation grids such as base of unconsolidated overburden are valuable. But the point here is that you want bottom and top of Key grids for each seam under consideration. These grids should in most cases be made by making a thickness grid for the strata and adding thickness to base elevation to obtain top of strata grids. There are two settings that should be monitored when doing this type of modeling. Under Settings, Carlson Configure, Mining Settings, be sure that pinch-out is on for modeling thickness. If not, then the seam will never pinch out in cases of zero thickness holes. When modeling elevation grids, it is often helpful that pinchout turned off, because when it pinches out a seam, it sometimes brings that elevation up to the next seam above, to pinch it out. If pinch out is off, it will keep the elevation grid down where it should be, had the seam been there. Add the two grids together to get the roof. Where the seam had zero thickness, the roof will be the same as the floor, and down and the correct elevation. The following example shows this concept, where the middle seam is pinching out in the middle. The middle hole has a zero value for coal thickness. This will bring the coal up to that hole, then pinch it at the hole.
This next example is created from the example where the seam Coal does not exist in the middle hole, not even a zero. This method will pinch the coal 1/2 way between the holes, based on the Pinchout Settings under Carlson Configure, Mining Settings. Most of the time, this is your best guess.

Using slightly different settings, this next Fence Diagram can be obtained.

Two Strata Limit Polylines were drawn around the drillholes, representing crop lines. The interior line is an exclusion limit line. The outer line is an inclusion limit line. The grids were remade, the bottom elevation and the thickness were added together to get the new roof, and here is the result. The seam carries its full thickness to the cropping limit lines, no pinching is taking place.

**Grid File Utilities**

The Grid File Utilities can be accessed from within the Advance Mining Menu by entering GFU, or under StrataCalc - Grid Utilities. It is also located in the DTM pulldown menu of the Contour-DTM module. After entering GFU, you must first choose Select Grid(s) to load a grid file. Within GFU, you can click an option to be prompted for Inclusion/Exclusion perimeter polylines. The grid manipulation will only occur inside or outside these perimeters.
The commands BPoly and Shrinkwrap under Draw are useful tools to generate these perimeters.

Adding One Grid to Another

In order to add grids, select Grid File Utilities (GFU) to bring up the dialog box shown here. Choose Select Grids and load the base elevation of the coal seam, COAL_ELV.GRD. The next step is to select ADD GRID which asks for the grid file to load (COAL_THK.GRD). At this point you would choose SaveAs" and save the result as file COAL_TOP.GRD. If this modeling effort is a one-time process, there is no need to record a macro that allows for automatic re-running of the grid addition. But if the thickness grid or base of coal grid might change due to the addition of more drillholes (or the editing of existing drillholes), then macros can be time-saving devices. To make a macro for our example, you would get to the dialog above by entering GFU as before. The upper right half of the GFU dialog is for macro recording. Choose Record to start the process. You would then chose Select Grids, choosing the Inclusion Perimeters (if applicable). This next window appears for variable and grid name selection. Comments can be entered here for reference.

Then Choose the Add Grid button. The variable B at top is representing the grid file to be loaded. The variable A has already been assigned to the grid file brought up by the option Load Grid. So A is COAL_ELV.GRD (the base of COAL grid). Be sure to select the option "Store the Grid File Name" as shown. Variable B will be the
The Need to Extrapolate

If modeling is done by Inverse Distance, Kriging or Linear Least Squares, the program will automatically extrapolate the grid, filling in values entirely within the limits of the grid location selected at the beginning of the gridding. If the modeling is done by Triangulation or Polynomial, the grid values will only exist within the area of drillholes. There will not be any grid values outside of the data set of drillholes. Thus the area of modeling by Triangulation or Polynomial will always be less than the area of modeling by Inverse Distance, Kriging or Linear Least Squares. This may create a problem in Grid File Utilities where grid addition is involved. Two things can happen. Number one, the program may complete the addition, but in reality grid values have not changed where the base grid file contained null values. Number two, the program may report "Grid files do not match" and refuse to do the grid math operation. To remedy this, choose "Extrapolate" within Grid File Utilities, select the default method, and extrapolate all grids prior to doing grid math. The extrapolate command itself can become part of the macro if record or append is selected. Other routines have the option to extrapolate, such as Grid Inspector, where there is a check-box to Extrapolate Grids. The Reserve commands will always extrapolate the grids upon loading, so it might be better to make sure they are extrapolated to start with. There are two options at the bottom of the Define PreCalc Grids dialog to extrapolate the grids. One method will extrapolate the elevation out, the other will merge with the next upper seam, pinching the thickness to zero.

Reserves from Pre-Calculated Grids

It is always preferable to compute volumes from PreCalc files using the Surface or Underground Mine Reserves. All the care and control that went into making the grid files is then reflected in the improved accuracy and legitimacy of the result. The PreCalc can contain quality attribute grids, and even a Block Model for detailed quality tracking and breakdown. The alternative is to select drillholes directly from the screen (on-the-fly), which builds in uncertainty as to the nature of the modeling.

Choosing a Method of Gridding

Every user is confronted with the issue of what method of gridding (modeling) to choose. Here there is no substitute for experience and verification in the field. We at Carlson Software have noticed that many qualities such as sulfur or calcium are modeled most often by Inverse Distance. Base elevation, in general, appears to be amenable to the logic of Triangulation or Polynomial, much like surface topography, though even here Inverse Distance is often
used. Strata thickness, however, is again more localized and is often best modeled by Inverse Distance or Least Squares. Polynomial surface modeling utilizes Triangulation, so again lends itself to broad, large area influences. When and how to use Kriging is an art in itself. We have found the "power" form of Kriging to model effectively in evenly distributed drillhole data. The following diagram shows the same drillhole data set modeled with 12 different versions of the algorithms. Notice there are some large differences, yet all have their benefits.

**Calculate Residuals**
This command guides the user to select a modeling method. The concept is much like field checking. With field verification, you would pick a location for testing, then measure coal thickness or sulfur or base elevation and check the data against the model. If it is close, your model is good. If the testing is repeated, you can add up all the errors (the residuals) and make a determination of the effectiveness of one model against another. But even without field testing, you can take 25 drillholes and model with 24, then check the error residual at the removed drillhole. You can then repeat this "removal" process across all 25 drillholes, and verify the average residual error and the standard deviation of the residual error. This is exactly what the command Calculate Residuals in the Advanced Mine Module does.
Shown below, for example, is a comparison all the modeling methods exported to Excel. This was done with Auto-Run Residuals, then using the Report Formatter, export to Excel.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Strata</td>
<td>Value</td>
<td>Model</td>
<td>Std</td>
<td>Dev</td>
<td>Res</td>
<td>Avg</td>
<td>Min</td>
</tr>
<tr>
<td>3</td>
<td>C1 KEY</td>
<td>Thickness</td>
<td>Triangulation</td>
<td>1.74</td>
<td>11</td>
<td>1.08</td>
<td>0.79</td>
<td>-0.94</td>
</tr>
<tr>
<td>4</td>
<td>C1 KEY</td>
<td>Thickness</td>
<td>Inv Dist 2.00 Pwr</td>
<td>1.57</td>
<td>19</td>
<td>0.95</td>
<td>-0.18</td>
<td>-4.09</td>
</tr>
<tr>
<td>5</td>
<td>C1 KEY</td>
<td>Thickness</td>
<td>Kriging</td>
<td>3.58</td>
<td>19</td>
<td>2.30</td>
<td>1.19</td>
<td>-3.86</td>
</tr>
<tr>
<td>6</td>
<td>C1 KEY</td>
<td>Thickness</td>
<td>Polynomial</td>
<td>1.82</td>
<td>11</td>
<td>1.04</td>
<td>0.65</td>
<td>-1.51</td>
</tr>
<tr>
<td>7</td>
<td>C1 KEY</td>
<td>Thickness</td>
<td>LeastSq</td>
<td>1.93</td>
<td>19</td>
<td>1.07</td>
<td>-0.12</td>
<td>-4.76</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In this example, Inverse Distance has the lowest standard deviation and absolute value residual average, making it the better candidate for modeling this drillhole dataset. The command Calculate Residuals will bring up a report that shows every drillhole and what the residual was. It will also create a Histogram, showing the number of residuals within certain ranges. This can be used to look for extreme values and fliers.
Modeling Options

It is important to set the strata modeling options that are in Settings Carlson Configure command under Mining Settings. These setting are used in modeling commands that process strata from drillholes such as Make Strata Grid, Surface Mine and Underground Mine Reserves and Strata Isopach Maps, just to name a few.

The Inverse Distance and Least Squares settings control the data point search radius and the maximum samples which limits calculations to the nearest set of the specified number of data points. Inverse Distance and Least Squares can also be forced to use a minimum and/or maximum number of data points from each quadrant NE, SE,
During strata correlation, the program matches strata with the same name between drillholes. When a strata name is missing in a drillhole, there are three possibilities. Either the program can skip that drillhole for modeling that strata, or the strata pinched out, or the drillhole did not reach the strata and the strata position can be modeled by conformance. The method to use is determined by the Pinch Out and Conformance settings in this dialog. If you turn off Pinch Out, then the program will skip a drillhole with a pinch out case for modeling that strata. Otherwise the missing strata will be given a negative thickness at the drillhole. The thickness is negative so that when modeled with the other positive thickness drillholes, the pinch out or zero thickness position will be somewhere midway between the missing and existing drillholes. The slide bar "Near Zero <-> Non-Zero" controls the amount of the negative thickness. The Near Zero setting will make a smaller negative value which moves the pinch out position closer to the missing strata drillhole. Likewise Non-Zero makes a larger negative value which moves the pinch out position closer to the drillhole with the strata.

For Conformance, turning off conformance will make the program skip a drillhole with a conformance case for modeling that strata. With conformance active, the missing strata position at the partial drillhole will be calculated by modeling the thickness between the missing strata and a marker strata that does exist in the drillhole. This thickness is modeled with inverse distance using drillholes where both strata exist. Then the thickness is added to the marker strata to locate the missing strata in the partial drillhole. Conformance can be set to Seam-Specific which allows only specified strata to be marker strata. Additionally, the specified marker strata will only conform with specified target strata. The marker and target strata names are set in Define Strata.

**Case Study #4: Limestone Block Modeling**

This lesson will step through modeling a limestone quarry using the Carlson block model routines. It goes through the process from start to finish, importing drillholes to final reporting and viewing graphics. Most of these commands are found in the Block Model menu of the Carlson Geology Module.

**Step 1-Import the Drillhole and Face Data**

To import the drillhole data, it is important to create an ASCII file with a repetitive series of columns for the collar x,y,z position, followed by columns for the downhole information. Shown here is an example of the spreadsheet to import.
To import the drillholes, it will need to be in ASCII form, use Excel to save the file in ASCII form with a ".csv" extension.

Answer Y to the question regarding saving the current worksheet. This results in a comma-separated file ASCII, such as this typical example, viewed with Notepad:

```
HOLE #,X,Y,Z,Z Top,Z Bottom,DESCRIPTION
1-03,25158.6200,18332.4000,652.9800,652.98,634.23,Bastard Stone,Bastard Stone
1-03,25158.6200,18332.4000,652.9800,634.06,632.98,Standard Buff, Standard Buff
... (more entries)
```

Notice that this file contains one "header" line consisting of the title, that we can ignore. Next we bring this file into Carlson by using the command Drillhole Import found in the Import/Export Drillhole flyout, underneath the Drillhole pulldown menu.
Before selecting this command, it is a good idea to pre-set the drillhole symbol to be used within the command Define Drillhole, located in the same Drillhole pulldown menu. Note that there is a rather large 25-unit drillhole dimension and have chosen a solid circle symbol, to distinguish the drillholes from the face data (which will use a small, solid square symbol). Also make sure the default Density is set for the ore.

By choosing "Save" in the lower left of the dialog, these settings are saved in the CH file named earlier. Then with the command Drillhole Import, the CH file will set the default symbol format. Now choose Drillhole Import and within this command, choose the Custom Import Formatter.
This window will appear:

Select "No", as they are in one CSV file.

Note that the default answer is "No" and can be selected by pressing Enter. Load the correct ".csv" file containing the ASCII drillhole data. Now organize the right-hand column to correspond to the ASCII file, as shown here:

Note how you can study the data file organization in the "Preview Window". This format can be given a name and saved by pressing the Save button. Note that we have specified "1" header line to skip (skip the title line) at the bottom right of the dialog, and also notice that we have chosen to skip the "Z Top" column, since the bottom elevation defines the strata, measuring down from the top, collar elevation. Press OK to continue. As a result of the import, we now have 7 drillholes in our area of study, as shown below:
Importing Drillholes is a critical process in geologic modeling, so it is important to be familiar with the precise techniques to accomplish this. Carlson offers extremely flexible importing. The drawing with the 7 new drillholes can now be saved with any file name desired.

You have the option to import these drillholes while already in a drawing (such as a topo map of the site), or you can import the drillholes into a blank drawing then insert additional surface features like contours. The Insert command can be found under the Draw pulldown in Carlson. In this case, we'll insert a contour file called Block Model Contours, to obtain the combined drawing below:

![Combined Drawing](image)

To verify contour elevations, and to check whether the top of the drillholes are close to the contour grades of the contours, use Drawing Inspector under the Inquiry pulldown menu. You will notice that all the holes top out at just about the right elevation you would expect based on the nearby contours, the only slight exception being the slightly lower drillhole shown below, where some of the surface could have been removed where the hole was drilled. It's just a few feet low:

![Drillhole Elevation](image)

Note also that if you inspect the blue boundary lines, they, too have elevation. Those lines should be set to zero using the command, "3D Entity to 2D" under Edit. Otherwise, they will impact surface modeling. It's a good idea to turn off the Drawing Inspector when you are not using it. Also, by right clicking with the mouse button when Drawing Inspector is on, you can change what you inspect (layers versus elevations, for example).

**Step 2- Set up Strata Definitions to Colorize the Strata**

This is a one-time process. The Strata Definitions file is used by Draw Geologic Column and by Fence Diagram and by the routines that color and display the block model. It can also impact tonnage calculations, because you can set the strata density within Strata Definitions. The dialog appears as shown below. The asterisk can be used to apply the definition to anything that begins with the letters preceding the asterisk. In this way, Standard Buff with Vertical Seam would be treated as all the other Standard Buff strata in terms of coloring and modeling.
The columns to be shown in the spread sheet can be set using Column Options. The values can be edited with in the spread sheet shown above or by selecting the strata row and using Edit button. You see more settings that can be changed.

Contrast the StandardBuff settings with those for Dirt, which we have colored black and designated "Non-Key", which means it is waste, not a product you are mining.

**Step 3-Draw Geologic Column**

Once you have verified your colors for the strata (again, a one-time process using Strata Definitions), it is valuable to confirm the quality of the drillhole import by drawing the geologic column. One method is to draw the columns next to the drillholes. So choose Draw Geologic Column at the bottom of the Drillhole pulldown menu. Possible settings for the dialog are shown below:
These settings produce the plot shown here:

This is the first indication of the location of the yellow standard buff, as well as the location of silver grey and other colored zones. The location of the black overburden material is also clear in the plot.

**Step 4-Assign a Bed Name to All Strata**

The block modeling routines require that the various strata be organized into beds. You might have a top 80-foot bed and a lower 100-foot bed in large deposits of ore. If you don't want to distinguish beds, just put all the strata into one bed name, like Stone. Note that if a column "Bed Name" was made in the original Excel file, all the strata could be imported with a bed name and you'd be done. You might consider removing the Ztop column in the original spreadsheet, and substituting a Bed column with the name Stone in every entry, then adjusting the custom import to bring it in. But to add Beds "after-the-fact", choose Assign Bed Names with Strata/Bed Utilities under the Drillhole pulldown menu. Select all drillholes and enter "Stone" for the bed name, for example. Enter N for No for "Use Parameter Filter". Then select all strata in the list at right. Highlight and click OK. Done.
**Step 5-Surface Mine Reserves**

You are now ready to get a volume of any material desired. Before you do the command, you will need a closed polyline perimeter. Note in the above graphic plot with contours, we have 3 blue squares, that might be areas of interest for volumes. Each might represent a mining block. But in reality, these are not closed polylines, but are drawn as individual polylines in approximate N-S and E-W directions. To create closed polylines where the zone of interest is "enclosed" by other polylines, a useful command is "Boundary Polyline" under Draw. Choose this command.

Pick all the blue polylines that "bound" the rectangle of interest (or that bound all the rectangles). Do not pick any contours or other polylines. Enter a snap tolerance of 1 (to "bridge" gaps of up to 1 foot). Enter the layer to draw the polylines in (CLAYER would put them in the current layer). Then pick inside, and the closed, rectangular polylines are drawn.

Now run the command Surface Mine Reserves under the Stratacalc pulldown menu. Fill out the dialog as shown, being sure to select "Block Model" method. This selection does an "on-the-fly" block model. The "Pre-Calculated" selection would work from a stored "pre-calc" file, which can be a block model or a strata-based model. Specify the block by elevation, entering the bottom and top of the zone of interest (we did 580 to 620 here).
Also be sure to select "Calculate Strata Qualities" and "Breakout Quantities by Attributes", options near the bottom left of the dialog. After you select all 7 drillholes to model (you can crossing select the entire screen, as only drillholes will be selected and the rest filtered out), you will get this dialog:

You can "Model by Strata Names" or by Color, since the Color attribute is the strata name! Next you can pick any of the strata to report, by selecting them:
If we choose Crawfoot, SilverBuff and StandardBuff, quantities will be calculated for that block. Next you pick the limits of the study area, from lower left (well below and left of the drillholes) to upper right (well above and to the right of the drillholes) and set your gridding resolution. Figure if you have 40' of elevation range, 80 vertical zones will give you about 0.5' per zone for analysis.

![Make Block Model dialog box]

Pick one of the inclusion perimeters, and you are taken to the "Report Formatter" as shown below. Here it is shown as it might appear with a fresh installation of Carlson, completely unformatted.
Move to the right the Silverbuff C.Y., the Standardbuff C.Y. and the Crawfoot C.Y. You can name the format in the upper middle box as Limestone1, so it is a report option available to you in the future (see below):

Click Display in the lower left of the screen, and you get the first report:
Step 6-Reporting in Cubic Feet: Making User-Defined Attributes for Reporting
When configured to "English" units, that is, feet, the program defaults volumes in the form of cubic yards. If you wanted to output cubic feet, then the default output variable for cubic yards needs to be multiplied by 27 to produce cubic feet. The variables "known" to the program can be listed, within the Report Formatter, by clicking the Attribute Options button at the bottom of the screen. A formula must be created for all of the named strata to convert cubic yards to cubic feet. Therefore, to obtain all of the strata in the Report Formatter, it is necessary to re-run Surface Mine Reserves using the same settings in the dialog, but when prompted for Choose Strata, select all of the strata, as shown.
Then when you press OK and complete the gridding process, all of the strata appear in the Report Formatter, either in the left or right column.

The next step is to click the User Attribute button at the bottom of the screen, which then produces the following dialog:

![User Attribute Dialog](image)

A few conversions are provided by default. We will need to add a conversion to Cubic Feet for each strata of interest. To begin, click Add.

![Add Conversion Dialog](image)

For the example of "BastardStone", you simply multiply the "known" variable for BastardStone by 27 to calculate cubic feet. Whatever is filled out for Description is what appears in the report. To see what the program uses as "known" variables, you click "List keys". The variable can be directly selected from this dialog, then the "*27" can
be appended in the equation. Items are listed alphabetically:

Repeat for each of the stone types involved. The pattern is, every time you click Add, click List Keys, choose the next stone of interest (e.g. BED\_CUT), multiply by 27 in the equation, fill out the new "key word" for the cubic feet variable, fill out the full description for reporting and the decimal places, consider whether to Total by Sum, use No Total, etc., then click OK. Repeat for each strata. In order to see "Crawfoot" as a strata, you may need to select a larger number of vertical divisions, to "reveal" the very thin Crawfoot seam and get it in the list. Note that this is a one-time process. The new key variables will always be retained on future work. The final table might appear as shown below:

Next, click OK and return to the Report Formatter. More the generic "Strata" and cubic yard items from the right column back to the left column and move all the desired cubic feet elements over to the right-hand column and save this new format as Limestone2.
Note that using the "User Attrib" button, you can make new elements for reporting, and these elements, like Standard Buff (C.F.), can be used in equations themselves, using their "key word" designation ("STANDARDBUFFCF"). Thus the Report Formatter can be used to produce all sorts of outputs and reports, all deriving from the known elements in the original report. To see results directly in Excel, click the "MS Excel" tab then click Export to Excel at the lower right of the dialog:

This leads to reporting directly in Excel:

Step 7-Viewing the Ore Body Model in 3D
So far, we have produced volumes of material by "on-the-fly" calculations. We have not created a block model of our strata. The block model has only been created internally by the program based on the selection set of drillholes. An official "block model" is made by the command "Make Block Model" at the top of the Block Model pulldown. Select that. Here again, you can make the block model directly from the strata names.

Choose the lower left corner of the grid by the "Pick" method, and using the "end" snap (for endpoint) pick the lower left corner of the site, then the upper right corner of the site, as defined by the rectangular polyline enclosing all contours. Then set the grid resolution as shown below. Since we are dealing with "named" strata that abruptly transition to another form, use the "discrete" method of modeling. Note that for ore bodies, where qualities are typically modeled, "inverse distance" or "Kriging" are more typical modeling methods.
Note also in the dialog above that you can set the vertical position for modeling at fixed elevations or you can follow the ore model. The "follow" method finds the top and bottom of the ore material, then divides the vertical positions as defined, here by 80 divisions. So if the ore material narrowed, then 80 divisions would narrow to a smaller dimension. If you want fixed vertical dimensions, choose "Fixed Elevations". After you click OK, select all strata to process, and name the block model to be created. Also create, for later use, the grade parameter file and "pre-calc" grid model. Click "Yes" to both the options below:

These options occur only when choosing the "Model by Strata Name" option above. Otherwise, you must use a pre-made Grade Parameter File and make the Pre-Calc Grid File by a separate process. The Grade Parameter File
sets the colors (and even pricing) for the named strata or quality zones (in the case of attribute-defined grades). Making the Grade Parameter File this way does not set colors that match the colors set in Strata Definitions. You will need to run the command, "Define Grade Parameters" under the Ore pulldown menu and change the colors to match what were used in Strata Definitions, for consistent viewing, so that the 3D Views match the colors in Draw Geologic Column, for example.

Now run Block Model 3D Viewer under the Ore pulldown, choose the "blk" Block Model File and the "gpf" Grade Parameter File, press "OK" at the Block Model Viewer dialog, then select a perimeter for viewing. You obtain a plot as shown below:

![Block Model 3D Viewer](image)

Note that you can exaggerate the vertical scale, or using the "Advanced" tab, you can switch from rendered view (above) to "Leave as Points" view. If you switch from Rendered to Points viewing, you must Exit the screen view (lower "exit door" icon) then repeat the command. Note that the yellow "Standard Buff" stone shows clearly in the 3D Block View, as does the red Void zone within the upper portion.

**Step 8-Viewing the Ore Body in Profile View (Fence Diagram)**

The process of making the Block Model was critical not only for 3D Viewing but also for the Profile View or "Fence Diagram". The 3D View used the "blk" file but the Fence Diagram command makes use of the "Pre-Calc Grid" or "pre" file as well as the "blk" Block Model File. Now that we have these, from Step 7 above, we can do the Fence Diagram. Before issuing the Fence Diagram command, draw a polyline through the drillholes or across the site that you will pick for the profile view of the strata (stone). Select Fence Diagram under the StrataCalc pulldown menu. Fill out the dialog as shown below:
You could choose to exaggerate the vertical scale by changing the vertical entries to 20 rather than 50 (scale, grid interval and text interval). Then pick the polyline to use for the profile, and the "pre-calc" and the "grade parameter file" as prompted. A typical result is shown below:

Case Study #5: Block Modeling by Quality Attributes

This tutorial takes a set of drillholes and goes through the steps that create the block model. The different grades are defined in the Grade Parameter File. Blocks are drawn and viewed in 3D for analysis. Cross sections are cut through the blocks and volumes by grade are calculated with Surface Mine Reserves. Finally, the Optimized Pit Design is found with the Lerch-Grossman algorithm.

The first step is to import the drillholes and name the beds based on how the seams are to be modeled. This example is a limestone bed with a thin layer of overburden, so there are just two main material types in the drilling, OB and LS are the bed names. The drillholes have already been imported for this example. That process is documented in other documents. There are 16 drillholes in this drawing. The drawing name for this tutorial is Block Modeling.dwg. Shown here are the plan view of the topography and the drillholes, and also the drillhole datasheet to display the drilling data.
This command is used to create the block model from the drillholes. The first selection is to choose the Bed Name to model, and then the quality or qualities. Just one quality attribute may be used, or several at once. In this example, the LS bed and the CaO attribute will be modeled, as shown in this window. It needs a grid file to set the horizontal block sizes, so either pick the position from screen, and put in a dimension for X,Y, or copy an existing grid for positioning. For this one, the Surface Topo.grd can be copied for a position, which is 20x20 in dimension.
The second window sets the block height and modeling method. There are two distinct methods for setting the block height. They can be set to a fixed elevation and size which is independent of the beds, or can follow the top and bottom of the ore model from the drillholes. This creates almost a stratified block model where the elevations of the blocks follow the top and bottom of the ore elevations. This is like a hybrid of both strata and block modeling. If there are not any strata, such as in a gold or copper deposit, then the Fixed Elevations method is preferred. Both methods work the same. If using the Fixed Elevations method, to set the block height, the top and bottom of the model are entered, with the number of samples chosen to set the average block height, which is calculated and displayed at the top. In this screen, if the Number of Vertical Divisions is set to 16, the average block height listed above is 10.9. This should work well with the horizontal size of 20x20, giving an average block size of 20x20x10. This example will use Inverse Distance as the modeling method with a vertical factor of 1. Selecting OK builds all of the blocks and puts them in the BLK file. Choose a name for the BLK file, such as LS_CaO.BLK.

This command defines the grade ranges of the ore. This is what defines the blocks for colors and divisions for cross sections and volumes. There is a Draw Legend button to put it on the map. The price per pound is also defined here for the cost model, and that will be used for the optimized pit design. Also notice that there are 8 blanks for the various Parameters where the combination of the several attribute ranges can define the grade. For example the CaO \( > 90 \) and MgO \( < 15 \) defines the "High-Grade". For this example, just the CaO is defined for the different ranges. If another range is already defined, then the program will just use what is available. That is why just the "\( > \)" option is used below, starting at the highest grade and working down.

Now that the block model is built and the grade ranges are defined, the model can be inspected and viewed in 3D to check it for any problems. If the model is large, it is best to use an inclusion polyline to view just a subset of the entire model. In the Advanced Tab, there is a way to turn the various blocks on and off like layers. Just click on the line to turn on or off and the blocks are removed or added from the screen. This allows 3D views to see what the quality is inside the middle of the blocks. Notice in this example there are just green and blue blocks remaining.
This is not a required step, but is convenient to place the blocks in the drawing permanently. This command will draw the blocks on screen in CAD as nodes or “dots”. These nodes can then be brought into the 3D Viewer window and rendered the same as the Block Model 3D Viewer does. The nice option in this command allows to have a top and bottom limiting surface to crop the blocks. That way if just the blocks on a certain bench want to be viewed, use just the top and bottom grids of that bench, or even the topography, and an inclusion perimeter, to contain the blocks to draw, and ultimately view. After selecting the file, just leave all set to "YES" on the Draw Block Model screen. The nodes and contours drawn in CAD can be viewed with the 3D Viewer Window as seen below.
This step is necessary to combine the block model with the surface topo and any top or bottom elevation surfaces that will make up the entire model. The procedure for strata models is to just add the elevation grids as normal, and then add the BLK block model file to the appropriate interval. Flat elevation grids can be used for this, if it isn't a stratified model that has roofs and floors, like many hard rock metal mines and quarries that aren't stratified.
Now that the entire model is built and checked, a Fence Diagram can be drawn to see the geology and blocks in section view. Fence Diagram has an option to Hatch by Block Model. This can be drawn in two ways. The initial section shows it on a 2D Grid, the second one can be seen in 3D where it draws and hatches the fence in 3D below the line, in Real World Coordinates. Shown below are two fence diagrams from the drawing, on a 2D grid. Notice the coloration of the blocks based on grade of limestone.
There is also an option to draw the Fence Diagrams in 3D using the Real World Coordinates setting. When this is viewed in the 3D Viewer Window along with 3D Geologic Columns, the result is very useful to visualize the geologic deposit as shown below. The Draw Geologic Column command will draw the drillholes as 3D columns, and they can also be colorized by the Grade Parameter File. Notice how the coloration in the drillholes corresponds to the coloration in the fence cross-sections, indicating and good modeling estimation.

The next step is to get the volume and tons of the different grades of limestone with the Surface Mine Reserves. There is one check box to turn on that will report the tons by grade, it is Breakout Quantities by Attributes. This will not only give total tons of the limestone, but also the tons in the various grades. Here is how the window should appear.
Shown here is the report of the data dumped into Excel using the Report Formatter. Notice how the total Key tons match the individual grade tons added up in the yellow cells. This is a good check to make sure all grades are accounted for in the report. Also confirm that each grade's CaO falls in line with the values defined in the Grade Parameter File.

Now to find the optimized final pit of profitable mining, we will run this command to create a value block model, where each block is assigned a cost associated with it. Once this value block model is created, then the Optimized Pit Design can be run. First, select the geologic block model to analyze. This is the file used in the steps above. Then choose either to use the Grade Parameter file, or to Enter the parameters on screen here. For this run, the Economic Parameters will be entered. Select the Surface Topography grid when prompted to do so. It will use this to calculate the overburden on top of the blocks.
Enter in the Economic Parameters. Shown here is a sample of the costs associated with the various mining stages. This writes the value block model, where each block now has a value assigned to it whether it is profitable or not. This file is named Value Block Model.BLK.

Now that the Value Block Model is written, the Optimized Pit Design is run to create the ultimate pit and create the ultimate pit block model. The Value Block Model is now the file to process, and this one is selected first. All options are turned on to create an ultimate pit grid, block model and a report. The block model is just for calculation purposes and contains cost values.

The final report shows that most of the blocks are mineable. Level 1 doesn’t have anything in it that is mineable. The lowest level, 5 is not mineable, though there are blocks in it. The blocks that are not profitable are what is left in the image below. The grid is displayed here, with the Surface 3D Viewer, and colored by elevation. It is easy to make changes in the input parameters and run it again. The cost to mine or process the ore can be modified and the new cost model created to see how it affects the output.
There is an automatic Grade Parameter File written called the Profit and Loss.GPF. This will colorize the blocks in the Value Block Model green if they are profitable, and red if they are not. This final model can also be viewed in 3D and it will resemble the ultimate pit grid file. Shown below is the full model, and then the profitable blocks are removed or "frozen" and just the red, non-profitable blocks remain.
Underground Mining Module
Notes Menu

The commands in the top section of the Notes pulldown menu are for underground mine note entry and surveying. The bottom section contains commands for inserted mine drawing embellishments. The Locate by Bearing and Azimuth are explained in the Survey section of the manual.

<table>
<thead>
<tr>
<th>Notes</th>
<th>Works</th>
<th>Property</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Mining Symbols</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate by Bearing</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Locate by Azimuth</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Defaults</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Left/Right/Plane</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note Auto Left/Right</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note from CoRd File</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Note on Centerline</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offsets from ASCII file</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add Core Hole</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bench Marks</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bottom Elev Points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resize Bottom Elev Points</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mine Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Section Name</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stoppages</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Escapeways (solid circle)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Takeup Date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N-E Line</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Insert Mining Symbols

This routine places icon mining symbols on the drawing. There are 25 symbols to choose from. After selecting a symbol from the pages in the Select option, simply pick a point to place it. A row of that symbol can be placed by picking a destination point, and an interval point. In this case, multiple symbols are placed the specified interval apart along a line from the start to the destination point. There are options for rotating the symbols, to erase existing symbols, layer name and symbol size.
Custom made symbols can be made with the command Edit Mining Symbols Library.

**Prompts**

**Mine Mapping Symbols Dialog**
Choose a symbol.
**Pick Point for Initial Placement:** pick a point
Edit Mining Symbols Library

This routine edits the mining symbols library. New symbols can be added and existing symbols can be edited. This is very similar to editing the points libraries in the Survey module. To add a new symbol, it must be drawn as entities in a dwg. Choose Create Symbol and give it a name. Choose a DWG to save it as, select the item, and pick the insertion point (usually the center). The new symbol should now be on the list in the library.

Prompts

Select objects: select the symbol
Pick Insertion Point For This Symbol: Symbol saved.
Mine Note Defaults

*Enter Coal Thickness at Offsets* activates coal section prompts in the mine note entry routines which creates sections of coal thickness at the offsets. The *Enter Coal and Rock Thickness at Offsets* option prompts for both coal and rock thickness. *Enter Coal Sections at Offsets* is a similar option that creates a complete coal section at the offsets. *Use Centerline Stations instead of Distances* will prompt for a starting station for the entries. Otherwise the starting station is automatically set to zero. The *Prompt for Spad Number* determines whether the program prompts for spad numbers for the entry points. Turning this option off saves a prompt if you are not using spad numbers. *Enter Distances Back From Face* is an option that allows all of the mine note entry routines to post back from the face. Once this option is set, you never need to set it again except to change it. When this option is on, you will be asked for the "Distance to Face" when starting a note entry routine. Also, each routine will display a message stating "Mine Note From Face Option Active". *Create ASCII File During Mine Note Entry* determines whether or not a record of the offset notes is kept in an ASCII file whose default name is OFFSET.DAT. This file is created by mine note entry routines and can be used by AutoMine Connections and Offsets by ASCII File. If this file already exists when a mine note entry routine is started, there is an option to either append the new notes to the existing file or replace the existing file. All these data files are stored in the Carlson data directory such as C:\SC14\DATA\. Since these files are in ASCII format, they can be easily edited with any text editor. Once ASCII File From Notes is set, you never need to set it again except to change it.

```
Mine Note Entry Options

☐ Enter Coal Thickness at Offsets
☐ Enter Coal and Rock Thickness at Offsets
☐ Enter Coal Sections at Offsets
☐ Prompt for Spad Number
☐ Use Centerline Stations instead of Distances
☐ Enter Distances Back From Face
☐ Create ASCII File During Mine Note Entry

OK  Cancel  Help
```

Mine Note Left/Right/Face

*Mine Note Left/Right/Face* is a simple routine for entering offsets. The flow of this routine is very similar to Mine Note from CooRD File. To get started, the routine only requires a starting point and a direction. Then enter a distance up followed by the offsets. The offsets consist of a code immediately before the distance. The codes are L for left, R for right, CL or *L for corner left, and CR or *R for corner right. For example, the offset CL9 means a corner point offset 9 feet to the left.

Corner points identify a corner of a pillar that is across a cross cut. Corner points are drawn as green dots and other points are drawn as red circles. This distinction is made to assist in pillar connection and is important to AutoMine Connections.

If the ASCII File From Notes option is on, this routine also produces a .DAT file which contains a record of the entries. This file is necessary for AutoMine Connections.
Prompts

Enter Offset File Name $\langle$offset.dat$\rangle$: press Enter
Enter/Pick From Station Point: pick or Enter a point
Entry Number: $1$ This is an identification number for the entries that follow. AutoMine Connections groups spad offsets by this number.
Enter/Pick To Station Point (a for azimuth): pick or Enter a point or enter A
Spad Number or $\langle$Enter$\rangle$ for none: $1043$ This number is drawn at the spad.
Flip Spad Text ($Y$/<$N$>)? $N$ This determines the orientation of the spad text.
Enter distance From Station/Spad on Centerline (Enter to end): $25$
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: $L10$ Offsets left $10$.
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: $CR9$ Offsets a corner point right $9$.
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: press Enter
Enter distance From Station/Spad on Centerline (Enter to end): $47$
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: $SL8$ Offsets a corner point left $8$.
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: $R11$ Offsets right $11$.
Offset, U for Undo, or $\langle$Enter$\rangle$ for new centerline distance: press Enter
Enter distance From Station/Spad on Centerline (Enter to end): press Enter

Pulldown Menu Location: Notes
Keyboard Command: note1
Prerequisite: None

Mine Note Auto Left/Right

Mine Note Auto Left/Right is a simple routine for entering offsets. The routine only requires a starting and ending point, and then simply distance up, distance left, and distance right over and over until the end of that entry. Corner points may be specified for left or right offsets by preceding the number with a C or *. Corner points identify a corner of a pillar across a cross cut. Corner points are drawn as green dots, while other points are red circles. This distinction is made to assist in pillar connections and is important for AutoMine Connections.

If the ASCII File From Notes option is on, this routine also produces a .DAT file in the data directory which contains a record of the entries. This file is necessary for AutoMine Connections.

Prompts

Enter Offset File Name $\langle$offset.dat$\rangle$: press Enter
Enter/Pick From Station Point: pick or enter a point
Entry Number: $1$ This is an identification number for the entries that follow. AutoMine Connections groups spad offsets by this number.
Enter/Pick To Station Point (a for azimuth): pick or enter a point or enter A
Spad Number or $\langle$Enter$\rangle$ for none: $1043$ This number is drawn at the spad.
Flip Spad Text ($Y$/<$N$>)? $N$ This determines the orientation of the spad text.
Enter Distance From Station on Centerline (U to Undo, Enter to end): $25$
Enter Left Offset Distance: $C10$ The C specifies a left corner point.
Enter Right Offset Distance: $8$
Pulldown Menu Location: Notes
Keyboard Command: note2
Prerequisite: None

Mine Note From CooRD File

This mine note entry routine is for when the spads are known coordinates or point numbers from a .CRD file. The flow of entering offsets for this routine is very similar to Mine Note Left/Right/Face. First enter the spads point coordinates...
number or coordinates, and specify the azimuth by either entering the number directly or by identifying another point. Then enter a distance up followed by the offsets. Pressing Enter at the offset prompt will back up the routine so that it asks for another distance up. Then, pressing Enter at the distance up prompt will make it ask for the next spad. Finally, pressing Enter to the spad question will exit the routine.

There are two types of offsets points, corner points and regular points. Corner points identify a corner of a pillar that is across a cross cut. Corner points are drawn as green dots and regular points are drawn as red circles. This distinction is made to assist in pillar connection and is important to AutoMine Connections. The offsets have a code immediately before the distance. The codes are L for left, R for right, CL or *L for corner left, and CR or *R for corner right. For example, the offset *R10 means a corner point offset 10 feet to the right.

Prompts

CooRD File Selection Dialog Choose the file that contains the spad point data.
Starting Spad or north & east coord: 1
Azimuth (DDD.MMSS) or P for Pt.-Defined Direction <0.0>: P
Directional Spad or north & east coord: 3
Distance or 'enter' for new Spad No.: 15
Offset or 'enter' for new Distance: L10
Offset or 'enter' for new Distance: CR10
Offset or 'enter' for new Distance: press Enter
Distance or 'enter' for new Spad No.: 17
Offset or 'enter' for new Distance: CL10
Offset or 'enter' for new Distance: press Enter
Distance or 'enter' for new Distance: press Enter
Next Spad No. or north & east coords or 'enter' to exit: press Enter
Print file containing offset input data (<y>/n): n

Pulldown Menu Location: Notes
Keyboard Command: note3
Prerequisite: None

Mine Note on Centerline
This command is similar to the other Mine Note routines like Mine Note Auto Left/Right. The difference with this routine is that the program does not prompt for offsets left and right. Instead the program only prompts for the distance along the centerline and places the offset points on the centerline (0 offset).

Prompts

Enter Offset File Name <offset.dat>: press Enter
Append File (<Yes>/No)? press Enter
Enter/Pick From Station/Spad point[node on]: pick a point
Entry Number: 1
Enter/Pick To Station point (a for azimuth): A
Azimuth of Heading (DD.MMSS) or p to pick <0.0>: 11
Enter Spad Number or <ENTER> For None: 101
Flip Spad Text (Yes/<No>): press Enter
Enter distance From Station/Spad on centerline (Enter to end): 40
Enter distance From Station/Spad on centerline (Enter to end): 60
Enter distance From Station/Spad on centerline (Enter to end): press Enter
Another Spad (<Yes>/No)? N
Print file containing offset input data (<Yes>/No)? N

Pulldown Menu Location: Notes
Offsets from ASCII File

This command can be used to update a drawing if the offset file is edited outside a Mine Note Entry command or a new drawing is started. Otherwise, the offset dots are drawn only once, while entering them with a Mine Note Entry command.

Offsets from ASCII File draws points that are defined in the specified offset file. The offset file is created by Mine Note Entry commands. In order to draw the points, a SPT99.DWG and a OFFSET.DWG must be in the Carlson Support directory that was set up when the software was installed.

Prompts

Enter the offset file <offset.dat>: Enter a filename. The default directory for this file is the data directory your Carlson Data directory that was created when the software was installed.

Pulldown Menu Location: Notes
Keyboard Command: moffsets
Prerequisite: An offset file created by one of the Mine Note routines

Drawing Embellishments

Mine Map Insert Commands

Here are ten very useful drawing embellishment commands. Add Core Hole, Bench Marks, Bottom Elev Points, Mine Name, Section Name, Stoppings, Escapeways (solid circle), Takeup Date, and N-E Line are straightforward routines that place their corresponding information in the drawing using the standard layer name, color, font, and height. The prompts for all nine inserts, as well as the Revise Bottom Elev Points routine, are listed below.

Prompts
For Add Core Hole:
Enter or pick 'x' and 'y' co-or of corehole location: pick a point
Corehole name: DH-8332
Surface elevation: 2115.30
Bottom of coal seam elevation: 1521
Total coal in inches: 65
Total impurities in inches: 4

For Bench Marks:
[node on] Pick Location Of Benchmark Elevation: pick a point
Enter BM Number: 834
Enter Elevation of BM: 734.65
Additional Text (Enter if none): V18-P
Pick Location For The BM Text: pick a point
Pick Alignment Point For Text: pick a point

For Bottom Elev Points:
Elevation : 1231
Pick pt. for elevation mark 'x' : pick a point
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point

For Revise Bottom Elev Points:
Select Bottom Elevation Marks & Text to Revise: pick object

For Mine Name:
Company name : Carlson Mining Company
Mine name : Carlson No,1
MSHA I.D. N.O.: 8332
State I.D. N.O. : 21153
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point

For Section Name:
Degrees of panel azimuth: 90
Minutes of panel azimuth: 00
Seconds of panel azimuth: 32
Panel name : North Mains
Panel I.D. n.o. : 2338
Panel in date : 3/1/05
Panel out date : 4/1/05
Additional notes : 60’x60’ Centers
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point

For Stoppings:
Pick point for beginning of stopping line orientation: pick a point
Pick point for end of stopping line orientation: pick a point
Pick point to beginning stopping: pick a point
Pick point to end stopping: pick a point

For Escapeways:
Pick pt. for escapeway symbol: pick a point

For Takeup Date:
Takeup date [ mm-dd-yy format ]: 3-1-05
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point

For N-E Line:
Enter Northing: 5000
Enter Easting: 5000
This will be placed in the drawing at the corresponding northing and easting.

Pulldown Menu Location: Notes
Keyboard Commands: chole, benchmark, botelev, botelev2, mname, sname, stop, xways, tdate, neline.
Prerequisite: None

Works Menu

The Works pulldown menu contains commands for underground mines and is divided into three sections with projections commands at the top, placing pillars and perimeters commands in the middle, and quantity commands at the end.

Basic Projections

Basic Projections will only produce a rectangular grid of projections (not angular). The sequencing begins by choosing a starting point, direction, and distance. Then enter the number of entries and their sizing. After the projection is drawn, stoppings and ventilation arrows may be added. This routine has fewer prompts and is more automatic than Advanced Projections. All projection lines are on distinct layers (PROJECTIONS, PROJSTOPPINGS, PROJVENTARROWS).
Prompts

Start pt. of belt entry: *pick a point* You are automatically placed in intersect and node snap mode.

Pick end pt. of belt entry: *pick a point*

Number of entries on left side: 3

Number on right side: 3

Entry spacing: 60

Crosscut spacing: 60

Plot Outer Rib Line y/<n>: *Y*

Cut Width <20>: press Enter

Offset to starting rib line (e.g. -10,0,<10>): press Enter

Offset to ending rib line (e.g. -10,0,<10>): press Enter

Offset xcuts y/<n>: press Enter

Pick pt. on xcut for beginning of stopping line: *pick a point*

Draw another stopping line <y>/n: press Enter

Pick pt. on xcut for beginning of stopping line: *pick a point*

Draw another stopping line <y>/n: *N*

Pick pt. on entry to begin drawing ventilation arrows [nea on]: *pick a point*

Distance between ventilation arrows: 120

<1>ntake or [R]eturn: *I*

Draw ventilation arrows on another entry <y>/n: *Y*
Pick pt. on entry to begin drawing ventilation arrows [nea on]: pick a point
Distance between ventilation arrows: 120
<intake or [R]eturn: R
Draw ventilation arrows on another entry <y>/n: N
Project another panel <y>/n: N
Pulldown Menu Location: Works
Keyboard Command: panel1
Prerequisite: None

Advanced Projections
Advanced Projections is a flexible routine that is an extension of Basic Projections. Besides creating projections this routine can also draw pillars and perimeter by using the Draw Pillars option. Other options include angling the crosscuts, offsetting entries, variable length entries, and different labeling schemes. All projection lines are on distinct layers (PROJECTIONS, PROJSTOOPS, PROJVENTARROWS). The pillars are drawn by default in the PILLARS layer and the perimeter is drawn by default in the PERIM layer.

Prompts
Pick Start Point For Belt: pick a point
Pick End Point For Belt, or <A> For Azi/Dist: A
Enter Azimuth ddd.mmss <>: 90
Enter Distance: 600
How Many Entries Left Of The Belt <0>: 3
How Many Entries Right Of The Belt <0>: 3

Based on the preceding dialog box responses, the following mine layout is created:
To create various entry spacings and lengths choose the Offset Prompt, Entry Spacing Prompt, and/or Entry Length Prompt check boxes.

Panel Settings Dialog
Spacing for Left Entry No. 1 <60.0>: 90
Spacing for Left Entry No. 2 <60.0>: press Enter
Spacing for Left Entry No. 3 <60.0>: press Enter
Spacing for Right Entry No. 1 <60.0>: 90
Spacing for Right Entry No. 2 <60.0>: press Enter
Spacing for Right Entry No. 3 <60.0>: press Enter
Enter Offset For This Heading <0>: press Enter
First Length along Entry: 60
Enter Length along Entry <540.0>: 60
Enter Length along Entry <480.0>: 60
Enter Length along Entry <420.0>: 60
Enter Length along Entry <360.0>: 60
Chapter 15. Underground Mining Module
Note: The length of the panel was shortened for display purposes. The PILLARS and PERIM layers are reserved layer names used in other routines in Carlson. The layer names can be changed here if you have other reasons to do so.

If you want to display the centerlines with the projections and be prompted for ventilation symbols (stoppings and ventilation arrows), then at the Panel Settings dialog box uncheck the Draw Outline and Pillars only checkbox.

The following panel layout is drawn without the ventilation stoppings or arrows.
Then you will see the Stoppings & Ventilation dialog box and upon filling it out you will be prompted as follows:

**Stoppings & Ventilation Dialog**

Pick pt. on xcut for beginning of stopping line: *screen pick*

Draw another stopping line *<y>/n:* *Y*

Pick pt. on xcut for beginning of stopping line: *screen pick*

Draw another stopping line *<y>/n:* *N*

Pick pt. on entry to begin drawing ventilation arrows [nea on]: *screen pick*

Distance between ventilation arrows: 200

*<I>*ntake or [*R]*eturn: *I*

Draw ventilation arrows on another entry *<y>/n:* *Y*

Pick pt. on entry to begin drawing ventilation arrows [nea on]: *screen pick*

Distance between ventilation arrows: 200

*<I>*ntake or [*R]*eturn: *R*

Draw ventilation arrows on another entry *<y>/n:* *N*

Upon filling in the prompts, the map will be drawn as shown above.

**Angled Projections**

It is possible to plot projections as centerlines, as pillars with a perimeter, or both. Within the Pillars section of the dialog, if the three dialog items on the left (Draw Pillars, Draw Outline, Pillars/Outline only) are selected, then only pillars and perimeters are drawn. This type of projection is particularly useful to represent the actual mine for purposes of scheduling equipment, using the Underground Mining Module. Here is an example of angled projections, with a "winged" look created by angling only the first 2 of 4 left and right entries:

If all 4 entries left and right are angled (rather than the 2 above), then the entire projection would be in angled form.
Add Rooms

Typical, Default Room Plotting requires that you click on the left-side Draw Pillars, Draw Outline and Pillars/Outline only, as well as click ‘Add Rooms’. A typical 2 left, 2 right standard projection with 120’ longrooms (current default) has the following dialog appearance and plot.

The default angles lean the left rooms to the left and the right rooms to the right at 60 degrees. The crosscut spacing on the longrooms default to $\frac{1}{2}$ the crosscut spacing on the main projections (60 in our case). I have noticed some irregular rooms if you use different crosscut spacing left and right-in that case, it might be better to plot the right side or left side separately. If the Join Perimeter with Center option is not selected, the projections will be in 3 parts: left, center and right. The outer left and right "extents" of the perimeter default to 30’ plus the distance to the center of the left- and right-most entries. In our case, that distance to the far entry is $2 \times 120 = 240$, meaning that the outer punchout is defaulting to 270’ left and right. I can change that addition of 30’ to any other desired number.

Rooms with Stubouts: You can add stub-outs within the main dialog, and the rooms will attach appropriately. In this example, Stub-out L and Stub-out R were set to 30.

Joining with Center Section: The next variation is to join a left or right section to the center (we don't allow joining all 3 at present). This can be done with or without stub-outs. To activate this option, turn on the Join Perimeter with Center option in the Room Dimensions dialog. Shown below is a left section joined to the center with no stubs involved. Below that is a right section joined with the center with stub-outs. The perimeters have been made bold for emphasis.
Rooms with stubouts connected to a standard panel

Changing Angles in the Rooms: Rooms can have a variety of angles for cutting through. To allow variation in angles, turn on the Angle Left Prompt in the Room Dimensions dialog. In this example, we did 60 (the default), then 60 and 60 in 3 entry left room. We did not vary the right condition. The prompting for the angle will remember the last entry, so the second "60" becomes just an "Enter" default on the left side.

Room with stubouts connected to a panel with stubouts

Left room connected to advancing panel
Right room connected to advancing panel

Angled rooms left (3+ X-cuts deep) and angled room right (2+ X-cuts deep)
Notice neither set of rooms were joined to the panel on the advance

Rooms with entry spacing variations

Entry Spacing Prompt: We can also choose to vary the spacing. In the example below, we did 0 left entries and 3
right entries, and we varied the entry spacing prompt on the right (and included stub-outs and Join Perimeter with Center). We entered 100, 140 and 120 for the three entry spacings and obtained the plot shown below:

Plotting Rooms with No Central Projection: This is useful for attaching left and right rooms to an existing mine plot. You pick your "centerline" as normal to get starting, but you answer 0 to both the number of left and right entries. Normally, this would simply exit the routine, but a new prompt asks "Do Longroom (y/n)". Enter "y" and you can place rooms to the left or right. (The program will only do one side or the other in a "no central panel" projection scheme. Repeat the process to add a right side to the left side rooms.) Here is the "look" of a left-side, 3 room section with no central projection:

Perpendicular Rooms and Offset Rooms

If the Room Dimension dialog is completed as shown below, rooms can be drawn at 90 degrees to the main entry, and can be offset as many crosscuts as desired. The offset up is measured by counting the number of room-size crosscuts. So if you have 40x40 rooms coming off 80x80 mains, and want to offset two main-size crosscuts (160 feet to the first rooms), then enter 4 (4×40 is 160) for the number of crosscuts to offset. Here is the result:
Projections & Ventilation

Projections/Ventilation makes heavy use of specification files. Once parameters have been established for a set of projections within a drawing file, you can save those parameters to a specifications file. When changes or additions are necessary, simply erase any undesired projections, load the file, make changes, and process. The specification file contains all the information contained within the dialog, including the projection and ventilation parameters, mandoor and stopping information, even the layer names to use.

These files can reside in any directory (usually the same directory as the drawing), and have the extension (*.PVS). When the program is activated for the first time within a drawing session, it will look for a PVS file with the same name as the drawing, in the drawing's directory, and if found will load it. If a PVS file with the drawing's name is not found, it will look for a file named DEFAULT.PVS in \\PROJECTIONS/VENTILATION subdirectory, and load it.

You can utilize this feature to your advantage by saving the general specifications about a particular drawing in a PVS file with the same name as the drawing. This way, if only the azimuth changed in a set of projections, you could open the drawing, activate Projections/Ventilation, change the azimuth, and process. You can also access the program's dialog box, enter and then store the specifications you would use most often across drawings as DEFAULT.PVS in \\SCAD\LSP subdirectory.

Dialog Control:
When Projections/Ventilation starts, it will display the dialog shown below. All specifications can be entered inside this dialog, and execution of the entity generation process can be initiated as well. Each section of the dialog will be explained in detail in appropriate subsections that follow.
All of Projections/Ventilation's options are accessed easily through this dialog with edit fields for parameters and buttons for each routine available in the program.

**Geometry Specifications:**
Before generating any entities using Projections/Ventilation, you must specify the geometric specifications of base point, azimuth, entries left/right, number of breaks, break and entry length.

**Base Point:** This button is used to specify the base point of the geometric entities. After picking this button, the dialog will temporarily disappear, allowing you full screen access to your drawing, and a prompt will appear at the command line requesting you to select a base point.

Choose the base point by picking or typing in coordinates. You MUST use an object snap (NODE, CENter, or INSertion) if picking the point graphically, to guarantee that the point selected is exactly on the point, spad circle, or insertion point of a point block.

**Azimuth:** This edit field is used to enter the projected azimuth. Enter the value in the format of DDD.MMSS, where the whole number of degrees are followed by a period, then minutes and seconds. If the minutes or seconds are less than ten (10), put a leading zero in front such as 01, 05, etc. If the minutes or seconds are zero, enter two zeros 00 as a place holder, especially for minutes.

**Entries Left:** This edit field is used to enter the number of entries to the left of the base point. A whole number is expected with no decimal points allowed.

**Entries Right:** This edit field is used to enter the number of entries to the right of the base point. A whole number is expected with no decimal points allowed.

**Break Count:** This edit field is used to enter the number of breaks to travel. The number of breaks times the break length will determine the total length of the set of projections. A whole number is expected with no decimal points allowed.

**Break Length:** This edit field is used to enter the length of each individual break. The break length and entry length do not have to be the same.

**Entry Length:** This edit field is used to enter the length (width) of each entry from the base point. The break length and entry length do not have to be the same.

**Projections:**
If the [x] Draw Projection Lines toggle is turned on, the program will create projection lines with cross break lines. These projection lines are drawn as lines, having a bylayer color and linetype, and placed on the layer designated...
in the layer dialog. See the section on layers for more information about changing layers of Projections/Ventilation entities.

Checking the [x] Draw Projection Pillars toggle can be used to simulate mine pillars. The simulated mine pillars will be polylines, having a bylayer color and linetype, and placed on the layer designated in the layer dialog.

**Beltline:**
Checking the [x] Draw Belt toggle will generate a set of parallel lines, centered about the base point, and running the entire length of the projections on the specified azimuth. The beltline will be lines, having a bylayer color and linetype, and placed on the layer designated in the layer dialog.

**Ventilation:**
Ventilation can be generated along with projections by checking the [x] Draw toggle in the ventilation section and supplying a few additional parameters.

**Distance Between Arrows [ ]:** This edit field is used to enter the distance between the sets (rows) of ventilation arrows. The sets will be placed along the entire run of projections.

The entry type list box shown, is used to setup the type of air flow in each of the entries. The program is setup to handle up to thirteen entries, but you can use as few as needed.

The process works by clicking your pointer button on the entries (in the list box) that you wish to change. When clicked they will become highlighted, or if they are already selected they will be un-highlighted. To change the air flow once entries are selected, press the button on the right corresponding to the type of air flow in each entry as Intake, Neutral, Return, or Exclude. If no air flow is to be designated for the entry, choose the Exclude button, which will draw no arrows. There are more entries available and will fit in the list box, therefore you may need to use the down arrow button on the scroll bar to view and change these.

If all items in the list need to be selected, press the Select All button, which highlights all items in the list. Additionally you can press the Clear All button, which un-highlights all items in the list.

Selecting the Symbols button allows customization of the arrows. Any of the mining symbols can be selected here.

![Ventilation Symbols](image)

**Stoppings:**
To generate stoppings while generating projections and ventilation, turn on the [x] Draw toggle in the stoppings
section and enter the headings where they should appear. The program can handle up to three rows of stoppings for split ventilation systems.

Row1-3: These edit fields are used to indicate the heading in which the stopping will be placed. Since stoppings are normally placed halfway between headings, the valid input will usually have a decimal value of (.5). For example, as shown above, if a row of stoppings is to be placed between the 4th and 5th entries, the valid input is 4.5. To exclude a row, set the value to 0.0.

The block inserted can be modified, and is stored as PVSTOPPIN.dwg in the SCAD\SUP subdirectory.

**Mandoors:**
Mandoors can be automatically added to stoppings. Turn on the [x] Draw toggle in the mandoor section and specify the additional parameters below.

Angle: Indicates the rotation angle of the door symbol when placed on the stopping. The default value of 0 should provide the desired results in most cases, but can be changed if needed.

Space: Indicates the distance between doors along the row of stoppings. Usually set to 300 or 500 feet, however any numerical value is acceptable. The program will track the running distance and automatically choose the correct break to place the mandoor in.

Break1: Indicates the break, relative to the Base Point, that the first mandoor should fall into. The program will begin tracking the space (described above), and place additional doors at the designated distance from this first break.

The block inserted can be modified, and is stored as PVMANDOR.dwg in the SCAD\SUP subdirectory.

**Escapeways:**
You can optionally place sets of escapeway symbols. Turn on the [x] Draw toggle in the escapeway section and specify the additional parameters below.

Prime: Indicates the entry number for the primary escapeway. The block is stored as PVESCPRI.dwg. Valid input would be a whole number with no decimal places.

Second: Indicates the entry number for the secondary escapeway. The block is stored as PVESCSEC.dwg. Valid input would be a whole number with no decimal places.

Offset: Indicates the distance to measure back from the row of ventilation symbols for the placement location of the escapeway symbol. Valid input would be a whole number with no decimal places.

The blocks inserted can be modified, and are stored in the SCAD\SUP subdirectory.

**Layer Control:**
Projections/Ventilation always generates the different sections of its geometry (projection lines, pillars, ventilation arrows, stoppings, mandoors, escapeway, and beltline) on separate layers. These layers can be easily changed within the layer dialog and are automatically saved when the specifications are saved. The layers used are self explanatory and are shown below.

![Layer Control Table]

---

Chapter 15. Underground Mining Module 2663
LAYER CONTROL SUB-DIALOG

To access the layer control dialog shown, press the layer button on the main dialog. After making changes to the layers, choose the OK button. If you wish to reject the changes made to the layer names, simply press the Cancel button.

Specification Save:
Projections/Ventilation can store all specifications previously discussed to a file for later recall. To save a set of specifications, choose the Save button from the main dialog. When pressed, a standard file dialog will appear (defaulting to drawing name) allowing you to save the *.PVS file. PVS stands for Projections/Ventilation specification file. When chosen, the default drawing filename will usually be the filename used for the PVS file. Accept this name or enter a new one, changing directories if appropriate. The normal scheme is to have one PVS file per drawing, having the same name as the drawing and stored in the same directory.

Specification Load:
Projections/Ventilation can re-load all specifications previously discussed to a file for later recall. To load a set of specifications, choose the Load button from the main dialog. When pressed, a standard file dialog will appear, allowing you to enter the *.PVS file. The default drawing filename will usually be the filename used for the PVS file. Accept this name or enter a new one, changing directories if appropriate.

Pulldown Menu Location: Works
Keyboard Command: panel3
Prerequisite: None

Rooms
This routine simply draws centerlines for the rooms. First pick two points to define the beginning side of the rooms. Then specify the room dimensions. Finally, enter the distance that the rooms extend from the edge and on which side of the edge to draw the rooms.

Prompts
Start pt. of rooms: pick a point
End pt. of rooms: pick a point
Distance between room entries: 40
Distance between room crosscuts: 40
Room Depth: 200
Rooms on <R>ight or [L]eft side: R

Pulldown Menu Location: Works
Keyboard Command: rooms
Label Projection Distances

As its name suggests, this routine labels the distances of a segment in a projection. It applies to projections created by Basic Projections or Rooms.

Prompts

Belt entry [ point to point mode ] y/n>: press Enter
Select line to label distance on: pick a projection line

Panel & Room Label Block

Panel Label Block and Room Label Block both draw labels with their corresponding dimensions.

Prompts

For Panel Label Block:
Insertion point: pick a point
Rotation angle: choose a rotation
SECOND DIMENSION <60'>: press Enter
FIRST DIMENSION <60'>: press Enter

For Room Label Block:
Insertion point: pick a point
Rotation angle: choose a rotation
ON ADVANCE OR RETREAT <ADVANCE> : press Enter
SECOND DIMENSION <40'> : press Enter
FIRST DIMENSION <40'> : press Enter

Draw Outline

Draw Outline creates a polyline in the OUTLINE layer out of the points you pick. The only intent of this routine is to draw old mine works.
Draw Perimeter

Draw Perimeter creates a polyline in the PERIM layer out of the points you pick. These points should compose the perimeter of a mine section. It is necessary to end picking points, and by entering C in order to make a closed polyline. The polyline must be closed, or inaccurate tonnages may result. Before using this routine, the points to connect can be placed using one of the Mine Note Entry commands.

Prompts

[node on] First Point: pick a point
Next Point, U to Undo, C to Close: pick a point
Next Point, U to Undo, C to Close: pick a point
Next Point, U to Undo, C to Close: C for close

Pulldown Menu Location: Works
Keyboard Command: oline
Prerequisite: None

Highlight Unclosed Plines

As its name suggests, this function will temporarily highlight polylines that are not closed. The intention of this function is for checking that the pillars and perimeter polylines are closed, since their closure is necessary for...
calculating quantities.

The procedure is to simply select the polylines to check. Then, after highlighting the selected polylines that are unclosed, the routine will pause for user input and then unhighlight the polylines. Thus, no changes are made to the drawing.

A polyline is considered closed if the endpoints are the same or if the closed flag is set. The closed flag can be set when creating a polyline, with the pline command, by using 'C' to close at the end.

**Prompts**

**Select the polylines to check.**

**Select objects:** select polylines

The program then reports either:

**Unclosed polylines are highlighted.**

**Close all or selected polylines (All/ <Selected >) ? press Enter** Look for the highlighted polylines and select the ones to close.

or

**All the selected polylines are closed.**

**Pulldown Menu Location:** Works

**Keyboard Command:** unclosed

**Prerequisite:** Polylines

---

**Chamfer Pillars**

Chamfer Pillars is meant for redrawing existing pillars that are notched at a corner by mine equipment.

Chamfer Pillars is similar to AutoCAD's chamfer expect that AutoCAD's works only on lines and Chamfer Pillars works only on polylines in the PILLARS layer. Chamfering basically creates a new edge that replaces a corner point and extends down each side a specified distance. In order to determine which corner to chamfer, this routine displays the dialog box shown below.

**A 40' x 40' pillar before and after chamfering the upper right 10' and the lower left 20'**

**Prompts**
Chamfer Dialog Box
Select the pillars the chamfer (polylines in the PILLARS layer).
Select objects: Select the pillars

Pulldown Menu Location: Works
Keyboard Command: pillar_chamfer
Prerequisite: Pillar polylines

AutoMine Connections
This command automates the connecting of dots for pillars and perimeters.

AutoMine Connections draws the pillars and perimeter of a mine based on point data in an offset file. This file can be created by one of the Mine Note Entry commands. There are two types of points in this file, corner points and regular points. Corner points, which appear as green dots, identify the first point across a cross cut for both the left and right side of a spad. Regular points are all other points, and are drawn as red circles. Corner points are critical to AutoMine. If a corner point is missing, AutoMine will become offset and the pillars will appear shifted. Each pillar must have exactly two corner points, one on the left and the other on the right. There can be no regular points between the two corner points on the pillar since AutoMine always directly connects the corner points together. For the perimeter, corner points are not important for the left and right faces. At the end face, however, corner points are required in order to identify the cross cut between the perimeter and the farthest pillar.

The order of entry of points in the offset file is significant in several ways. For one, the spads need to be in left to right order in the direction of mining. To do this, the spads can be entered in order, or the spads can be assigned sequential entry numbers. Another reason to assign entry numbers to the spads is to allow appending of the offset file. When reading appended files, AutoMine will group spads according to their entry number. The spads with the same entry number may be entered in any order since AutoMine sorts these spads by the distance along the direction of mining. For example, provided that spad 2 and spad 4 have the same entry number, then spad 2 and spad 4 offsets may be entered either spad 2’s offsets then 4’s or spad 4’s offsets then 2’s. The offsets within each spad, however, are not sorted, but are drawn in order. Consider, for instance, the cut in the left face of the perimeter in the figure below. These points must be entered in the order 1 then 2 then 3 then 4.

AutoMine removes any pillar or perimeter that is already in the drawing at the same location.

After drawing the pillars and perimeter, AutoMine leaves a pick box hanging off the perimeter so that you may connect it with a previous perimeter.

![AutoMine Connections Diagram]

Starting Point: N 5000.00 - E 5000.00
Entry no. 1
Azimuth: 0.4100
Distance on Centerline: 3.00
Left: 9.00
Distance on Centerline: 23.00
CRight: 9.00
Distance on Centerline: 61.00
Left: 9.00
Right: 9.00
Distance on Centerline: 62.00
Left: 19.00
Distance on Centerline: 77.00
Left: 17.00
Distance on Centerline: 78.00
Left: 9.00
CRight: 9.00
Distance on Centerline: 84.00
Left: 11.00
Distance on Centerline: 111.00
Left: 11.00
Right: 8.50
Distance on Centerline: 117.00
Right: 9.00
Distance on Centerline: 131.00
Left: 9.50
CRight: 9.50
Starting Point: N 5000.00 - E 5065.00
Entry no. 2
Azimuth: 0.4100
Distance on Centerline: 22.00
CLeft: 8.00
CRight: 10.00
Distance on Centerline: 24.00
Right: 8.00
Distance on Centerline: 56.00
Left: 10.00
Right: 9.00
Distance on Centerline: 61.00
Left: 12.00
Starting Point: N 5070.00 - E 5065.00
Entry no. 2
Azimuth: 00.4100
Distance on Centerline: 4.00
Right: 9.00
Distance on Centerline: -3.00
Right: 21.00
Distance on Centerline: 8.00
CLeft: 11.00
Distance on Centerline: 20.00
CRight: 16.00
Distance on Centerline: 24.00
Right: 9.00
Distance on Centerline: 43.00
Left: 9.00
Distance on Centerline: 49.00
Left: 12.00
Right: 9.00
Distance on Centerline: 62.00
CLeft: 12.00  
CRight: 9.00  
Starting Point: N 5000.00 - E 5130.00  
Entry no. 3  
Azimuth: 00.4100  
Distance on Centerline: 4.00  
Right: 10.50  
Distance on Centerline: 19.00  
CLeft: 10.50  
Distance on Centerline: 24.00  
Left: 8.50  
Distance on Centerline: 36.00  
Left: 15.00  
Distance on Centerline: 54.00  
CLeft: 12.00  
Distance on Centerline: 108.00  
Left: 9.00  
Distance on Centerline: 114.00  
Left: 13.00  
Right: 9.00  
Distance on Centerline: 129.00  
CLeft: 9.00  
Right: 9.00  

Prompts

**File Selection Dialog Box**
Select a mine note file. This file must contain points in the format described above.

**Next Point, U to Undo, P for Polyline, C to Close:** C

**Pulldown Menu Location:** Works  
**Keyboard Command:** automine  
**Prerequisite:** An offset file created by one of the mine note routines

**Auto-Connect Pillars**
This routine automatically draws pillar polylines by connecting the selected offset points. The points must be offset points created by one of the Mine Note routines such as Mine Note Auto Left/Right. In addition to the points, polylines must be drawn through each crosscut. The routine works by connecting the points such that no connection crosses a crosscut polyline. The crosscut polylines can be drawn individually with the Draw Polyline command or created as projection polylines with the Advanced Projection routine.

To use the routine see the layouts below. The first layout is created using Mine Note Auto Left/Right to locate the offset points. The centerlines were laid out using Advanced projections.
It is a good idea to manually connect the outer offset points manually and let this routine connect the internal points. Using the Polyline command and with the Osnap setting on Nodes, connect the perimeter points and create them in the PERIM layer as shown:

Next, connect the internal points using the Auto-Connect Pillars command. Select the points to be connected and the center lines that separate them. See the results here:
Prompts

Select pillar points and projection lines.
Select objects: select the points and lines

Pulldown Menu Location: Works
Keyboard Command: autopillar
Prerequisite: Offset points and crosscut polylines

Pillar Cut

Pillar Cut serves two purposes relating to final cuts that are made into pillars. It automates the process of drawing cut pillars, and it creates new pillars and perimeters for use in calculating the tonnage removed from the cuts.

The command is run by first choosing a cut pattern, then selecting the pillars to cut, and finally placing the pattern inside a pillar. The pillars must be closed polylines in the PILLARS layer. The cut pattern can contain either open or closed polylines. When an open pattern symbol is placed in a pillar, Mine Pillar Cut calculates the intersections between the pillar and the end segments of the symbol, and fits the pattern into the pillar. With a closed symbol, the cut pattern is clipped against the pillar. There are two effects this placement can have. One is to recreate the pillar with the cuts taken out. The other creates perimeter polylines inside the pillar in the spaces that are cut out.
Open cut patterns will not work if they divide a pillar into two or more separate pillars. Use a closed cut pattern if the pillar will be cut through.

To create custom cut patterns, create polylines in the desired pattern either as closed polylines or open polylines whose end segments will intersect the pillar when extended. Make sure that the polylines are the correct size to fit with a pillar. Then start Pillar Cut as usual and select the User-Defined symbol. It will ask you to select an insertion point, and pick a place in the table to store the new symbol. The next time Mine Pillar Cut is called, the new pattern
should be in the table.

Prompts

Mine Pillar Cut Symbols Dialog
Select a symbol to cut with or select User-Defined to begin the procedure to define your own symbol.

Enter the azimuth for the cuts <0.0>: press Enter This allows the cuts to be rotated when placed.

Cut the pillar or create new perimeter? (<Cut>/Perim) press Enter a string If Cut is selected, the pillar is re-drawn with the cut hacked out. If Perim is selected, perimeter polylines are created inside the pillar in the spaces that are cut out. The removed portion can be hatched with PERIM.

Select mine pillars (polylines in the PILLARS layer).
Select objects: select polylines This creates the set of pillars that may be cut. These pillars must be closed polylines in the PILLARS layer.

Pick a point for the symbol: pick a point This point must be inside one of the selected mine pillars.

Pulldown Menu Location: Works

Keyboard Command: cutsym

Prerequisite: Pillars to cut and drawn as polylines in the PILLARS layer

Boundary Enclosure

This routine is intended to be used in mines that include different leases or property ownerships. If the property is bounded by a polyline, Boundary Enclosure can be called to divide the mine into separate sets of pillars and perimeters. Then other routines such as Quantities by Average Method can use these sets to determine the exact tonnage quantities for that property.

Boundary Enclosure separates the pillars and perimeter of a mine into two sets based on a boundary line. One set consists of pillars and a perimeter from inside the boundary line and the other set consists of pillars and perimeter from outside the boundary line. If a pillar or perimeter crosses the boundary line, it is divided into two or more new polylines. In some cases, part of the new polyline may follow the boundary line. The boundary line must be a closed polyline. The one restriction on the boundary line is that it cannot create a disjoint inside set of pillars and perimeter. Disjoint outside sets may be created.
Prompts

Enter a color (1-7) <No change>: 2 The pillars and perimeter inside the boundary will change to this color.

Select a boundary polyline: pick a polyline If the point where the polyline is picked crosses additional polylines, all polylines will be highlighted. Pick another point on the desired polyline that distinguishes it from the others.

Select mine pillars and perimeter.

Select objects: pick the selection set of pillars and perimeter These pillars and perimeter must be closed polylines in the PILLARS or PERIM layer.

PullDown Menu Location: Works

Keyboard Command: bound

Prerequisite: Pillars drawn as polylines in the PILLARS layer and perimeter drawn as polylines in the PERIM layer

Draw 3D Mine Model

This command takes the 2D series of linework and converts it to a 3D underground representation of the room and pillar mine. It uses the pillars and perimeter polylines and extrudes them to the thickness of the seam that is being mined.

The above starting linework for 3D conversion

This command will extrude the linework to either the thickness from a flat base, or to a roof and floor defined by either elevations or elevation grid files. The input layers are defined so that the program knows what layers to look for. The Output layers are defined for the new 3D faces that are to be drawn in the assigned layers.
Once the 3D faces have been drawn, they can be viewed in the 3D Viewer Window under the View menu. In the Advanced Tab, the Shading Mode can be set to Both so that both the top and bottom of the faces will be rendered. If that is too dark, then it should be left to just Top mode.

### Prompts

**Command:** UG3D  
Select Pillar and Perimeter entities to be drawn in **3D**: select the mineplan polylines  
**Select objects:** Specify opposite corner: 2 found  
Inserting points...  
**Processed:** 4 Perimeters and 1217 Pillars

**Pulldown Menu Location:** Underground Module, Works  
**Keyboard Command:** ug3d
Configure Section Info

This procedure allows you to configure the names, abbreviations, and density of the various strata that appear in your underground mine. Also, the appearance of the section is specified by this routine. This information is needed for placing sections on the drawing which in turn are needed for Quantities by Average and Grid Method. If you reconfigure section info of an existing coal section, the sample points placed using the previous section info will become invalid and must be replaced.

The strata of a section can be configured as either individual or composite. With the individual configuration, each strata has its own name and density. With composites, each strata is still named separately but they also are divided into groups that have a group name and density. The principle advantage to composites is that it allows you to enter and list out each strata height and then combine the strata into their corresponding composite category when generating tonnage quantities.

Mine Boundary Enclosure Example

Warning: After Configuring Section Info be sure to save your drawing. This will get AutoCAD to update the section Block information. Otherwise there can be a conflict between the version of the Block settings and the *.SC file which Carlson creates during Configure Section Info.

Prompts

For an Individual Section:
Enter Coal Section Configuration file name <Drawing name.SC>: SECTION1 (Or the name of your choice.)
Mine Name: Enter a name.
Enter Abbreviated Strata Name/<ENTER> to End: C This name is drawn next to the corresponding height when a section is located in the drawing.
Enter The Full Strata Name <C>: Coal This name is used in quantity reports.
Enter Abbreviated Strata Name/<ENTER> to End: B
Enter The Full Strata Name <C>: Bone
Enter Abbreviated Strata Name/<ENTER> to End: R
Enter The Full Strata Name <C>: Rock
Enter Abbreviated Strata Name/<ENTER> to End: press Enter
Enter Individual densities or Composite densities (I/C) <I>: press Enter
Average wt. of C (Coal) [lbs/ft3]: 80
Average wt. of B (Bone) [lbs/ft3]: 150
Average wt. of R (Rock) [lbs/ft3]: 150
Circle the Coal Section (y/<n>)? Y This specifies whether a circle is drawn around the section when it is placed in the drawing.
Plot the Numeric Value Only (y/<n>)? press Enter

Chapter 15. Underground Mining Module
For a composite section:

Enter Coal Section Configuration file name <Drawing_name.SC>: SECTION2 (Or the name of your choice.)

Mine Name: Enter a name.

Enter Abbreviated Strata Name/<ENTER> to End: TC
Enter The Full Strata Name <C>: Top Coal
Enter Abbreviated Strata Name/<ENTER> to End: TR
Enter The Full Strata Name <C>: Top Rock
Enter Abbreviated Strata Name/<ENTER> to End: BC
Enter The Full Strata Name <C>: Bottom Coal
Enter Abbreviated Strata Name/<ENTER> to End: BR
Enter The Full Strata Name <C>: Bottom Rock
Enter Abbreviated Strata Name/<ENTER> to End: press Enter
Enter Individual densities or Composite densities (I/C) <I>: C

Define the Composite Categories:

Enter Composite Category/<ENTER> to END: Coal
Average wt. of COAL [lbs/ft^3]: 80
Enter Composite Category/<ENTER> to END: Rock
Average wt. of ROCK [lbs/ft^3]: 150
Enter Composite Category/<ENTER> to END: press Enter

Assign the strata to a composite category:

Enter Composite Category for Top Coal TC (COAL ROCK): coal
Enter Composite Category for Top Rock TR (COAL ROCK): rock
Enter Composite Category for Bottom Coal BC (COAL ROCK): coal
Enter Composite Category for Bottom Rock TC (COAL ROCK): rock
Circle the Coal Section (y/<n>)? press Enter
Plot the Numeric Value Only (y/<n>)? press Enter
Text Size <6.0>: press Enter
Prompt for entry width (Yes/<No>)? press Enter The entry width value is used in Quantities by Centerlines.
Place Coal Sections

This routine places a block circle and text of measured section information on the drawing. It serves two purposes: to display the sections for plotting, and to calculate tonnage. Carlson reads the location and values of the section from the block circle and not from the text.

For blank thickness entries, the program can either assume a zero thickness or ignore the section point for that strata. Which method to use is defined in Configure.

Prompts

Coal Section Configuration File Dialog
Pick sample point for coal section: pick a point This places a block circle.
Pick Start Point: pick a point This is where the text begins.
Pick Alignment Point: pick a point
Now enter your measurements.
How many Inches of Coal C: 51 Which quantities it asks for here depends of the configuration file.
How many Inches of Rock R: 9

Edit Coal Sections

This routine edits the measured section information already placed on the drawing. To edit this information, pick the section block circle and the text. Then a dialog box will appear which allows you to change the current amounts of that section.

Quantities by Average Method

Quantities by Average Method is one of three commands that calculate tonnages based on coal cross section data. The other routines are Quantities by Grid Method and Quantities by Centerlines. The grid method is more accurate but the average method is faster and requires fewer coal section sample points. The centerline method uses entry row centerlines instead of pillar and perimeter polylines.
Before executing this command, there must be sample coal section points and pillar and perimeter polylines in
the PILLARS and PERIM layers. The pillars and perimeter polylines can be made with the Draw Pillars, Draw
Perimeter, or AutoMine Connection commands, and sample points are placed by the Place Coal Sections command.

The quantities can also be reported by property owner. The property areas are defined by closed polylines with an
attached property name. There are routines in the Boundary menu of the Underground Mining module for assigning
the property names to the polylines. Quantities by Average Method will prompt you to select property polylines. If
you do not select any, then just the total quantities will be reported. Otherwise the quantities are divided between
the properties and reported separately.

Quantities by Average Method generates detailed a report when it is done calculating. The format of the report
method can be Standard text, Column text, or reported with the Report Formatter. Besides this detailed report, the
command Report Tons and Acres gives coal tonnage reports based on data files that Quantities by Average Method
updates. In order to have these data files updated, you must enter beginning and ending dates and an ownership
name when prompted. If this information is entered, Quantities by Average Method will add the current tonnage to
the data file for the specified ownership name. The data files for the mine and panel names will also be updated if
they are specified. The first time a mine or panel data file is accessed, it will ask for the estimated coal reserves.

Hatched drawing with the area summaries for each property boundary
Text Report Example

Report Formatter option

Prompts

Coal Section Configuration File Dialog
Select property polylines or press Enter for none: select the property boundaries
Coal recovery percent <100.00>: press Enter
Which type of selection? [Standard/Cuts]: press Enter
Select pillars, perimeters, and section sample points. Select these carefully so you only choose the pillars inside the perimeters. Section sample points can be selected outside the perimeter, if they contribute to a more accurate answer.
Pick location to draw results or Enter for none: This is where the Area/Pillar Area/Net Area will be posted for the first property boundary.
Pick Alignment Point: This sets the text direction.
Pick location to draw results or Enter for none: This is where the Area/Pillar Area/Net Area will be posted for the second property boundary.
Pick Alignment Point: This sets the text direction.
Another area [Yes/No]? N
Start point or Center/Middle/Right/?: This refers to the insertion point for the text report to be posted.
Height <6.00>: 10
Rotation angle <90d0'0'': press Enter for East to West (Horizontal) text
Layer for text <REPORT.TXT>: You can set any layer for the text report.
Insert as MText or Text [MText/Text]?: press Enter for MText
Update coal tonnage files [Yes/No]? N

Pulldown Menu Location: Works
Keyboard Command: qavg
Prerequisite: Pillars and perimeter polylines and coal sections

Quantities by Grid Method

Quantities by Grid Method is one of two commands that calculate tonnages based on pillars, perimeter and coal cross section data. The other routine is Quantities by Average Method. The average method is faster and requires fewer coal section sample points, but the grid method is more accurate because it creates a 3D model of the strata which finds deviations the averaging misses. Either Triangulation or Inverse Distance methods can be used for the grid model.

Before executing this command, there must be at least three sample coal section points and pillar and perimeter polylines in the PILLARS and PERIM layers. Perimeters may only be used one at a time. The pillars and perimeter polylines can be made with the Draw Pillars, Draw Perimeter, or AutoMine Connection commands, and sample points are placed by the Place Coal Sections command. Also property owner polylines can be used as described in the Quantities by Average Method command.

Quantities by Grid Method generates a detailed report when it is done calculating. Besides this detailed report, Report Tons & Acres gives coal tonnage reports based on data files that Quantities by Grid Method updates. In order to have these data files updated, you must enter beginning and ending dates and an ownership name when prompted. If this information is entered, Quantities by Grid Method will add the current coal tonnage to the data file for the specified ownership name. The data files for the mine and panel names will also be updated if they are specified. The first time a mine or panel data file is accessed, it will ask for the estimated coal reserves. There are three options for reporting, Standard, Column and Formatter.
Prompts

Select the file that defines the coal section sample points.
Coal recovery percent <100.00>: press Enter
Select property polylines or press Enter for none: select property boundaries only
Select pillars, perimeters, & at least 3 coal section points Select these carefully to only include the ones for the calculation. If you select more than you need and the hatching does not look correct, undo and repeat.
Processing cells ...
Another area [Yes/<No>]? If you want to process more than one area and calculate them together select another area. When you have selected all of the areas the program prompts you for the location if the report.
Start point or Center/Middle/Right/?:
Height <6.00>: 10
Rotation angle <90d0'0' }): press Enter
Layer for text <REPORT.TXT>: press Enter You can assign a new layer name if you choose.
Insert as MText or Text [<MText>/Text]?: press Enter
Update coal tonnage files [<Yes>/No]? N
Report window

Report Formatter

Pulldown Menu Location: Works
Keyboard Command: qgrid
Prerequisite: At least three coal sections and pillar and perimeter polylines
Quantities by Centerlines

This command calculates strata quantities based on coal sections and polylines along each cut. The coal sections contain the thickness for each strata and the entry width. When defining the coal section format in Coal Section Info, the Entry Width option must be activated.

Before running Quantities by Centerlines, polylines should be drawn along each cut. This routine sums the polyline lengths to find the linear feet of advance. Crossing cut polylines are handled by subtracting one entry width from the length for each crossing. Multiplying the linear feet of advance by the average entry width gives the mined area which is multiplied by the average strata thicknesses to obtain the strata volumes.

Prompts

Coal Section Configuration File
Select the file that defines the coal section sample points.
Beginning date of takeup [format mm-dd-yy] <3-1-05>: press Enter
Ending date of takeup [format mm-dd-yy] <4-1-05>: press Enter
Ownership/description <Smith(ABC)>: press Enter
Coal recovery percent <100.00>: press Enter
Select centerlines and section sample points. select objects
Another area [Yes/<No>]? N
Start point or Center/Middle/Right/?: Left pick start point or input option
Height <6.00>: 10
Rotation angle <90d0'0''): press Enter
Layer for text <REPORT.TXT>: press Enter to accept default, or input another layer name for the report
Insert as MText or Text [<MText>/Text]? : press Enter to accept default, or input std for standard text
Update coal tonnage files [<Yes>/No]? Y to update or N to end function

The report is shown here:
Pulldown Menu Location: Works
Keyboard Command: qentry
Prerequisite: Coal sections and polylines

Report Tons & Acres

When you run the take-up procedures Quantities by Average, Quantities by Grid, or Quantities by Centerline, at the end of the procedure after the routine has posted the take-up report you are prompted to update the Tonnage Report. The Tonnage Report gives you the option of keeping track of tons for an Owner, Mine, and each Panel for specific periods of time.

Mine Report produces coal tonnage reports for a specified mine, panel, or ownership.

NUMERICAL AVERAGE COAL SECTION METHOD
Individual Stratas Configuration
MINE: LEAF MINED FROM - 3-1-05 TO - 4-1-05
AREA NO. 1 DESCRIPTION:
LINEAR FEET OF ADVANCE: 2005.95
AVERAGE ENTRY WIDTH: 18.20
NET AREA MINED (S.F.): 36508.30 NET ACRES MINED: 0.838
AVERAGE Coal THICKNESS (INCHES): 59.00 (FEET): 4.92
AVERAGE Hard Rock THICKNESS (INCHES): 4.00 (FEET): 0.33
TOTAL MINING HEIGHT (INCHES): 63.00 (FEET): 5.25
AVERAGE Coal WT. (LBS/CU. FT.): 77.00
AVERAGE Hard Rock WT. (LBS/CU. FT.): 104.00
Coal (TONS): 6910.72
Hard Rock (TONS): 632.81
NON-RECOVERABLE COAL (TONS): 0.00 COAL RECOVERY PERCENT: 100.00%
TOTAL TONS : 7543.53 PERCENT COAL BY WT.: 74.06%
COAL ACRE-FEET: 3.196
CAVITY ACRE-FEET: 3.740

Reports are created for a certain time period. If no dates are entered, a report is generated that includes all the known data. Besides reporting the tons mined for the period, Mine and Panel reports also include the total reserves and remaining reserves.
Coal tonnage data is made with the Quantities by Average Method or Quantities by Grid Method commands, and the data is stored in *.MIN, *.PAN, or *.OWN files in the data directory. These files are in a straightforward ASCII format and may be edited by the Inquiry Dropdown > Display Edit File command.

Prompts

**Type of report (Mine, Panel, <Owner>):** Enter a name

**Report Source File selection dialog** The available data files are displayed for selection.

**Enter a beginning date (MM-DD-YY):** enter a date If no date is entered, the earliest date in the data file is used.

**Enter a ending date (MM-DD-YY):** enter a date If no date is entered, the latest date in the data file is used. You can also select the files from the dialog box.

![Sample source mine data file](image)

Sample Mine Report

- **Mine Report**
  - Time period: 3-1-05 to 4-1-05
  - Tons mined: 11136.18
  - Acres mined: 1.56
  - Total reserves: 2000000.00
  - Remaining reserves: 1979014.66

- **Sample Mine Report**
  - Time period: 4-1-05 to 5-1-05
  - Tons mined: 4923.58
  - Acres mined: 0.79
  - Total reserves: 2000000.00
  - Remaining reserves: 1979014.66

- **Mine Report**
  - Time period: 3-1-05 to 5-1-05
  - Tons mined: 16061.76
  - Acres mined: 2.35
  - Total reserves: 2000000.00
  - Remaining reserves: 1979014.66
Output report to printer (Y/<N>): enter Y or N
Besides outputting to the screen, the output can be sent to a printer in the PRN slot.
Do another report (Y/<N>): enter Y or N

Pulldown Menu Location: Works
Keyboard Command: mreport
Prerequisite: Quantity report files

**Property Menu**

The Property menu has commands for managing property boundary polylines.
Assign Property Names

In order to evaluate the quantity and/or quality of ore mined on the particular property, Carlson employs the use of closed polylines representing the property boundary. This function is used for assignment and modification of the owner and property ID names to these polylines. The following commands support property lines:

Quantities by Average
Quantities by Grid
Surface Equipment Timing
Surface Production Timing
Underground Timing
Surface Mine Reserves
Reserve Classification

This command simply prompts to select the polyline and type in the owner and ID. Property polylines supersede the Boundary Enclosure command for the purposes of calculation, since the use of property polylines does not require actual subdivision of the mine plan into properties. Instead the subdivision is performed internally "on-the-fly" by the cutting of a given polyline (such as whole mine property or monthly production pit polyline) against an underlying set of property lines.

In its current implementation the use of property lines has the following limitations: property lines should be closed polylines and make sure that they do not overlap other property lines. If a portion of a pit or panel is outside of all property lines, then in the report, the owner will be reported as UNKNOWN.

Prompts

Select property polyline:
Property Owner Name<>: Federal
Property ID<>: #J1267

Pulldown Menu Location: Boundary
Keyboard Command: property_line

Remove Property Data

When property information attached to the polyline is no longer needed, it may be removed by using this command. Multiple polylines may be processed at once.

Pulldown Menu Location: Boundary
Keyboard Command: clearprop
Property Data Report

This command uses the report formatter to create a report showing all property data associated with the selected property lines. They must be linked to the MPD file where all of the property data is stored.

<table>
<thead>
<tr>
<th>owner</th>
<th>property ID</th>
<th>Year</th>
<th>Land Use</th>
<th>Contract ID</th>
<th>Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal</td>
<td>789</td>
<td>1958</td>
<td>Grazing</td>
<td>ID#RA34</td>
<td>22 years</td>
</tr>
<tr>
<td>Jones</td>
<td>123</td>
<td>2005</td>
<td>Mining</td>
<td>2393432</td>
<td>10 Years</td>
</tr>
<tr>
<td>Smith</td>
<td>456</td>
<td>1914</td>
<td>Farm</td>
<td>1914-C</td>
<td>100 Years</td>
</tr>
<tr>
<td>State</td>
<td>246</td>
<td>1971</td>
<td>Crop Land</td>
<td>343-2984</td>
<td>15 Years</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Boundary, Property Line Tools
Keyboard Command: reportprops

Setup Property Link

This command creates the link between the property lines in the drawing and the database. The data can come from an XML file, a TXT or CSV file, an XLS file, an Access MDB file, or miscellaneous ODBC data sources.

After choosing which format it is, select the Continue button.
This Access database shows some data entered in for four different properties.

After choosing the source file, this selection window appears if it is from an Access database. Choose the table the data is stored in.
There are then four choices on how to join the data. The first is to empty the existing data set which would delete
the property and ownership line data. The second is to merge the data, using both data sets. The third option is to
append all to the end of the data, and finally, the last option is to append any new data, and merge the common data.
The next Data Merge table displays all of the available fields. Notice in this example, there are two Owners and two
Properties. In this case, the Merge option is the way to go.

Choosing Index Field on the first Owner gives the following result. The data is now merged and ready to be used
for reporting and reserve runs. Any time these property lines are used in reserves, all of this data is available for
reporting. Choose Continue will process the data and return to the command line.
Property Names By Text

This command converts a large number of closed polylines into property lines by using text label placed inside of the polyline. You are prompted to select closed polylines to become property lines and then the program tries to locate a text label inside each closed polyline that has the same layer as that closed polyline. The text is used as the owner name and the property ID is set to blank.

When you have text labels to start with but no closed polylines, use the Boundary Polyline command under Draw menu to create closed polylines from appropriate linework by using the text insertion point.

Identify Property Lines

This command is one of several property line tools available to identify and trouble shoot property lines. To identify a property line, simply click inside the polyline and the name of the owner and property ID will be displayed in the command text window.

Prompts

Pick on or inside of property polyline:
Owner: State
Property: 459a
Pick on or inside of property polyline:
Owner: Jones
Property: 34
**Pulldown Menu Location:** Boundary, Property Line Tools  
**Keyboard Command:** idprop

### Label Property Lines

This command labels property lines in either automatic placement or manual pick modes. When the Automatic mode is selected, the label is placed at the center of the property line.

#### Prompts

Select all property polylines to label:  
Select objects:  
Select label placement method [Pick/<Auto>]? A  
Label text size: 100

**Pulldown Menu Location:** Boundary  
**Keyboard Command:** labelprop

### Find Property Lines

This command locates property lines by matching the user provided search pattern against owner name and property ID of all property lines in the drawing. All matching property lines will be highlighted. The wildcard character (*) can be used in the search pattern.
Show All Property Lines
This function displays all property lines in the drawing either by highlighting them or by using solid fill. The latter option works for detection of the unassigned properties totally surrounded by the other properties. It is also convenient for location of tiny gaps between properties shown in the timing report as small areas with an UNKNOWN owner.

Prompts
Solid-fill the properties [Yes/<No>]? Y

Pulldown Menu Location: Boundary, Property Line Tools
Keyboard Command: showprop
Break Polyline by Property
This command breaks a closed polyline into separate closed perimeters where they cross property lines. This is useful when smaller, individual perimeters are desired for pits or panels.

![Before and After images of polyline division by property]

Prompts
Select polyline to divide by owners:

Pulldown Menu Location: Boundary
Keyboard Command: ownerdivide

Extract Centroid Data
This command is used to convert property information imported from ArcInfo using shape files into property lines. It searches for polyline centroids, extracts the necessary information stored there and attaches it to the property line. This will only work in AutoCAD MAP.

Pulldown Menu Location: Boundary, Property Line Tools
Keyboard Command: import_shape

Underground Menu
The Underground menu has commands for mine layout and timing. The Mining Project Manager command is described in the Geology section of the manual. There are several different methods for placing panels for the mine layout. The differences between these routines is outlined in the chart below.
**Place Panel**
- Provides the high level of detail, allowing user to specify every setting for every panel during mine layout.
- Level of details: Moderate, depends on amount of settings edited.
- Layout speed: Fast.
- Mine plan versatility: Creates a complete mine plan with "tree-like" connectivity, like a "tree-like" connectivity, providing maximum information for timing precedence.
- Main application: Best for laying out a complicated mine plan with multiple units working and numerous unconnected panels.

**Quick Place Panel**
- Provides the high level of detail, allowing user to specify every setting for every panel during mine layout.
- Level of details: Fast.
- Layout speed: Quickest, most streamlined. Very efficient in placing perim with direction.
- Mine plan versatility: Generates mine plan consisting of separate panels with equipment panels with no equipment assigned, already assigned, or not assigned. Correct timing sequencing is user responsibility.
- Main application: Ideal for trial runs on large number of panels, where fast plan creation and extensive modifications are the must.

**Pick & Place Panel**
- Provides the high level of detail, allowing user to specify every setting for every panel during mine layout.
- Level of details: Assumes default panel settings except for name.
- Layout speed: Slowest, but generates timing results as layout progresses.
- Mine plan versatility: Generates mine plan consisting of separate panels with equipment panels with no equipment assigned. Correct timing sequencing is user responsibility.
- Main application: Best for laying out a mine plan with relatively complicated mine plan large number of pan-

**Auto Place Panel By Text**
- Except for extraction options in the beginning all panel settings are default.
- Level of details: Provides the high level of detail, allowing user to specify every setting for every panel during mine layout.
- Layout speed: Quickest, most streamlined. Very efficient in placing perim with direction.
- Mine plan versatility: Generates mine plan consisting of separate panels with equipment panels with no equipment assigned. Correct timing sequencing is user responsibility.
- Main application: Established mine plan with relatively minor modifications in minor modifications in future.

---

Chapter 15. Underground Mining Module
Timing Project Manager

The Timing Project Manager (Surface Project Manager or Underground Project Manager) applies to both surface and underground mining for file organization and selection. All files and most settings and configurations used in the mine scheduling are found in the manager. Each topic is described below in detail.

Settings

- **Coloring Settings**: These settings are from the Report Options screen from the equipment timing command. Defaults can be set here before running the actual schedule. Explanation of this dialog is found in Underground Timing or Surface Equipment Timing. The screen appears as shown here.
**Drawing Event Types:** Drawing events are entities in the drawing at a specific location that will be used for a marker in the schedule as an option for a delay. This event can be used to delay equipment, switch crews, move other equipment, etc. When the schedule crosses over the insertion point of the drawing event (usually text) the event will trigger the delay or effect. The text/drawing entity in the drawing should be inserted to the position where the delay where occur and in the AutoCAD layer defined in the Capture Layer window. The Event Key and description can be used in the reporting of the schedule to create additional reported items.
• **Calendar Event Types:** Calendar events are named events that will determine equipment down time. The default event in the calendar is Manual. The other events are set under the Calendar Event Types and Calendar Event Definition. Calendar events can be any event that will cause a delay, such as a routine maintenance, a long wall move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working with crews, using hours, but not mining).

**Equipment**

- **Equipment Set:** The productivity of the unit (crew) may vary from shift to shift, up to 4 shifts a day. The number of shifts is set in the Timing window where the sequence of pits or panels is set. The average productivity rate is used for scheduling, however the production rate for the particular pit or panel may be adjusted by setting the difficulty factor or adding delays for that pit or panel. The first window is the edit equipment screen with a columnar display of equipment. Crews can be defined to work with a specific unit, or can switch from unit to unit based on the schedule.
Add and Edit will bring up the next screen for detailed entry.

The Unit of the Production value is defined by a rate unit setting. Equipment may mine either tons, tonnes, CY or CM, Distance and Linear Advance. The difference between distance and linear foot of advance settings is that latter one is a combined length of all pathways/entries mined (underground only), and distance is just distance moved, of a longwall for example.

Enter the Advance Rate/shift or the Advance Rate/hour and the other will be automatically calculated based on the Hours/shift. The Retreat Rate/shift is for Distance and Linear ft of Advance in underground equipment only. The availability value of less than 1.0 will reduce effective production rate of the equipment. 0.94 is a 94% productivity of the full shift.
Underground units may be assigned an Advance minimum and/or maximum height, so that the extra rock will have to be mined or correspondingly unmined coal will be left in the seam if the maximum miner height is less than combined coal and rock parting thicknesses. These settings affect the underground mine timing only. The maintenance settings provide the ability to schedule a delay for routine or major maintenance/repair of the equipment based on the number of shifts worked. Add in the length of the delay and the number of shifts to determine the frequency.

If operational cost per hour is specified, the total cost will appear in the production report.

The extraction (recovery) factor is used to adjust the amount of material mined from given area to account for certain technical limitations of the equipment such as inability to mine out corners, or not cleaning the top and bottom of ore. This machine will always use that recovery rate.

Advanced Options:

Under the Advanced options the variation of equipment-related Difficulty Factor with time, depth or bench number may be specified. Resulting from the advanced options, the difficulty factor is a product of coefficients calculated for given date, thickness and bench number. The final difficulty factor used in calculations is a product of location-specific and equipment-specific difficulty factor.

In the Period End Date column, the difficulty for the date is for next, later date, or last one if no later entry exists. For the thickness column the value of difficulty factor between two entries in the table is a linear approximation. The rehandle value is calculated in the same fashion and passed over to the report, not being used in calculations, but can be used in the report in equations to calculate the total amount mined. The difficulty will modify the rate, and the rehandle is reported. These are not necessarily always the same, linear factors. The Bench Specific Difficulty will be used for surface equipment mining on that bench number, and use that difficulty factor to change the rate of the equipment.

Selecting Edit All from the first screen brings up this editor where all equipment may be viewed and edited. Both the first screen and this one have the import and export buttons.
Calendars

- New or Existing Calendar: Highlight the Calendar tree, and the New Calendar button is activated if no calendars are present. If some are present, the edit button will also be active for editing a calendar. If it is a new calendar, the Calendar Name box appears to enter a name.
The Equipment Calendar allows for entity production down time. By default, entities are working every day, every shift. Entities include equipment, crews, pits and panels. Days and shifts defined in this calendar as down-time are taken into account during scheduling routines. The assignment pattern is very flexible: it works for a particular crew or all crews, for a particular shift or the whole day and allows replication of the defined behavior over period of time as desired. The calendar will clean out, or purge a schedule for a crew which is no longer present.

• **Date Selection:** The calendar should initiate on the current day. Use the left/right arrows to scroll through the months and years. The current or selected day is shown in blue. The shifts appear on the right of each day. There can be up to 4 shifts. If the shift is green, then all entities are working; if it is yellow, then some are working and some are down. If the shifts are black, then all entities are down on that day and shift.

• **Event Rule Definition:** This section is where the event down times are created and edited. Apply adds the event, Reset clears it for the next assignment.

• **Event Entity Filter:** The event list contains the Equipment, Pits or Panels and Crews. The choices for filtering are All Entities, All Equipment, All Crews, All Pits/Panels, Selected (highlight the desired Entity), and Matching (highlight the Entity to find the match).

• **Shifts:** The number of shifts checked here will display next to each day.

• **Due to/Calendar Events:** The options for down time are selected here. The default event is Manual. The other events are set under the Calendar Event Types, activated by clicking the button next to the "Due to"
Calendar events can be anything that will cause a delay, such as a routine maintenance, a long wall move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working).

- **Repeat for/Label**: This setting is how often the down time will repeat. This can be from a day, month, year or indefinite. This event can have a name, which is entered in the Label window. The calendar will refer to this label when encountering and reporting this event.

- **Events for Date Selected/All Defined Events**: This window displays the events for the highlighted day. If the List All Rules is on, then all the Events will be displayed here, no matter which day is highlighted.

- **Rule Report**: This report displays all of the rules defined for down time within the calendar.

- **Year Report**: This reports all days for the selected calendar year.

- **Unit Report**: This reports all equipment and dates defined in the calendar. See example below.
• **SaveAs/Load**: This saves the calendar, optionally as a new name. Load will open a new one, and give the option to append to the existing, open calendar.

![SaveAs/Load](Image)

**Timing Assignment**

The Timing Assignment allows for setting the current sequence. The Assignment is similar to the TIM file in the timing routines. The equipment used and which panels or pits they are mining are shown. The Set Current button controls which one will be loaded and used. Shown here is both a surface mine and an underground mine example.
Panels

This displays the selected underground panels in the mine plan assignment. An example is shown here.
Attribute Groups

Attribute groups are Pit or Panel Attributes assigned to the pits and panels for timing. When timing the pits or panels, there are additional attributes that will be calculated and reported in addition to the Non-Key and Key quantities. If these are defaults that should be applied to all the panels or pits, then they should be entered here. Any quality values, density, or difficulty attributes can be defined here either just as a value, or as a grid file with varying values. The Reserved Attribute Names window displays the reserved words that will be recognized in the timing routines, and how they should be entered in. Selecting Keyword Help brings up the Reserved Attribute Names.
The Reserved Attribute Names are defined in a little more detail here:

- **THICKNESS**: Key strata thickness: Will report any other thickness values, this is used mostly for underground timing.
- **DENSITY**: Key strata density: Will report Key density, is used mostly in underground timing to calculate the tons. In surface timing, the tons are already in the pits.
- **ROCKTHICK**: Non-key strata thickness: Reports the Non-Key thickness mostly for underground timing.
- **ROCKDENS**: Non-key strata density: Reports the Non-Key density mostly for underground timing.
- **TIMEGRID**: User-defined grid to use for timing: This will be any additional grid the user would like to add for reporting.
- **DIFFICULTY**: Difficulty factor on advance just for underground timing: This will alter the underground equipment rate on advance.
- **RET_DIFF**: Difficulty factor on retreat for underground timing: This will alter the underground equipment rate on retreat.
- **DIFF_BENCH***: Difficulty factor for bench * for surface timing: This will speed up or slow down the equipment as it mines the specified bench. If a value is above 1, such as 1.2, then it will mine 20% slower at that point in the grid, or everywhere if it is set to value. If it is less than 1, such as 0.84, then it will mine 16% faster at that point.
- **XXXX_BENCH***: This is the dominate attribute that is most widely used in this command for surface pits. All quality grids will be defined in this fashion, for each bench. The example above, BTU_BENCH1, is defined
in this way. All quality parameters need to be entered as the NAME_BENCH*.

**Reports**

Some of the reports generated in the scheduling will appear here for other options to report. These are also accessed in the calendar or after a schedule is run.

![Image of Mining Project window]

**Data Links**

This shows the link of the data when it is linked to an external source for reporting.
Define Equipment

This command is for inputting and editing the equipment for scheduling routines. It is accessed only in the Timing Project Manager. The productivity of the unit (crew) may vary from shift to shift, up to 4 shifts a day. The number of shifts is set in the Timing window where the sequence of pits or panels is set. The average productivity rate is used for scheduling, however the production rate for the particular pit or panel may be adjusted by setting the difficulty factor or adding delays for that pit or panel. The first window is the edit equipment screen with a columnar display of equipment. Crews can be defined to work with a specific unit, or can switch from unit to unit based on the schedule. Crews are created in the Calendar section of the Timing Project Manager.
Add and Edit will bring up the next screen for detailed entry.

The Unit of the Production value is defined by a rate unit setting. Equipment may mine either tons, tonnes, CY or CM, Distance and Linear Advance. The difference between distance and linear foot of advance settings is that latter one is a combined length of all pathways/entries mined (underground only), and distance is just distance moved, of a longwall for example.
Enter the Advance Rate/shift or the Advance Rate/hour and the other will be automatically calculated based on the Hours/shift. The Retreat Rate/shift is for Distance and Linear ft of Advance in underground equipment only. The availability value of less than 1.0 will reduce effective production rate of the equipment. 0.94 is a 94% productivity of the full shift.

Underground units may be assigned an Advance minimum and/or maximum height, so that the extra rock will have to be mined or correspondingly unmined coal will be left in the seam if the maximum miner height is less than combined coal and rock parting thicknesses. These settings affect the underground mine timing only.

The maintenance settings provide the ability to schedule a delay for routine or major maintenance/repair of the equipment based on the number of shifts worked. Add in the length of the delay and the number of shifts to determine the frequency.

If operational cost per hour is specified, the total cost will appear in the production report.

The extraction (recovery) factor is used to adjust the amount of material mined from given area to account for certain technical limitations of the equipment such as inability to mine out corners, or not cleaning the top and bottom of ore. This machine will always use that recovery rate.

**Advanced Options**

Under the Advanced options the variation of equipment-related Difficulty Factor with time, depth or bench number may be specified. Resulting from the advanced options, the difficulty factor is a product of coefficients calculated for given date, thickness and bench number. The final difficulty factor used in calculations is a product of location-specific and equipment-specific difficulty factor.

In the Period End Date column, the difficulty for the date is for next, later date, or last one if no later entry exists. For the thickness column the value of difficulty factor between two entries in the table is a linear approximation. The rehandle value is calculated in the same fashion and passed over to the report, not being used in calculations, but can be used in the report in equations to calculate the total amount mined. The difficulty will modify the rate, and the rehandle is reported. These are not necessarily always the same, linear factors. The Bench Specific Difficulty will be used for surface equipment mining on that bench number, and use that difficulty factor to change the rate of the equipment.

Selecting Edit All from the first screen brings up this editor where all equipment may be viewed and edited. Both the first screen and this one have the import and export buttons.
**Pulldown Menu Location:** Surface in Mining  
**Keyboard Command:** editcrews

---

## Equipment Calendar

Note: Equipment Calendar is also located in the Surface Module section.

This command is accessed through the Timing Project Manager under Underground. Highlight the Calendar tree, and the New Calendar button is activated if no calendars are present. If some are present, the edit button will also be active for editing a calendar. If it is a new calendar, the Calendar Name box appears to enter a name.
The Equipment Calendar allows for entity production down time. By default, entities are working every day, every shift. Entities include equipment, crews, pits and panels. Days and shifts defined in this calendar as down-time are taken into account during scheduling routines. The assignment pattern is very flexible: it works for a particular crew or all crews, for a particular shift or the whole day and allows replication of the defined behavior over period of time as desired. The calendar will clean out, or purge a schedule for a crew which is no longer present.

- **Date Selection:** The calendar should initiate on the current day. Use the left/right arrows to scroll through the months and years. The current or selected day is shown in blue. The shifts appear on the right of each day. If the shift is green, then all entities are working; if it is yellow, then some are working and some are down. If the shifts are black, then all entities are down on that day and shift.

- **Event Rule Definition:** This section is where the event down times are created and edited. Apply adds the event, Reset clears it for the next assignment.

- **Event Entity Filter:** The event list contains the Equipment, Pits or Panels and Crews. The choices for filtering are All Entities, All Equipment, All Crews, All Pits/Panels, Selected (highlight the desired Entity), and Matching (highlight the Entity to find the match).

- **Shifts:** The number of shifts checked here will display next to each day.

- **Due to/Calendar Events:** The options for down time are selected here. The default event is Manual. The other events are set under the Calendar Event Types, activated by clicking the button next to the "Due to" window. Calendar events can be anything that will cause a delay, such as a routine maintenance, a long wall
move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working).

- **Repeat for/Label**: This setting is how often the down time will repeat. This can be from a day, month, year or indefinite. This event can have a name, which is entered in the Label window. The calendar will refer to this label when encountering and reporting this event.

- **Events for Date Selected/All Defined Events**: This window displays the events for the highlighted day. If the List All Rules is on, then all the Events will be displayed here, no matter which day is highlighted.

- **Rule Report**: This report displays all of the rules defined for down time within the calendar.

- **Year Report**: This reports all days for the selected calendar year.

- **Unit Report**: This reports all equipment and dates defined in the calendar. See example below.
• **SaveAs/Load:** This saves the calendar, optionally as a new name. Load will open a new one, and give the option to append to the existing, open calendar.

**Pulldown Menu Location:** Reserves/Timing in Surface Mining and Underground Menu  
**Keyboard Command:** calendar  
**Prerequisite:** Equipment and crews should be defined for the routine to be used in its full capacity

---

### Set Attribute by Grid File

This command assigns an attribute value such as thickness or BTU to a panel or pit area based on the average value from a grid file. The program prompts for the attribute name and the grid file that represents the attribute. Then multiple panel/pit perimeter polylines can be selected and the program calculates the average grid value in each panel/pit polyline and stores this value.

Another method for using grids is to define the attribute as the actual grid file name instead of the average value. Then the timing routines will calculate attribute values for each timing block from the grid value. The advantage to using Set Attribute by Grid File instead of using the grid file is speed.

The Calculate Seam Split Quantities option is for calculating coal and rock thicknesses by analyzing multiple strata elevation grids using minimum and maximum miner heights. When the coal thickness is less than the minimum height, the minimum height is used. The maximum height is used when the coal thickness is greater than the maximum height. A fixed amount of rock thickness that is always taken can be specified. Given the miner height, the program will find when the miner takes main coal seam plus the parting and any of the second coal seam. The average coal and rock thickness for each panel polyline is calculated and stored.

---

*Chapter 15. Underground Mining Module*
Define Panel Attributes

The panel attributes are used in timing calculations and reporting to define coal quantities and qualities within the panel. Any attributes assigned to panel are included in the timing report. The list of attribute names and values is attached to the panel perimeter polyline. There is a number of predefined attributes:

Attribute Defaults to Meaning
THICKNESS 6ft Coal seam thickness
DENSITY 80lb/sq.ft. Coal density
ROCKTHICK 0ft Rock parting or rock to mine
ROCKDENS 150lb/sq.ft. Rock density

The Attribute Groups are accessed in the Timing Project Manager. These and other attributes may be defined and assigned a value to be used as the default. The attributes with no value assigned will be shown in Edit Panel Attributes dialog for the particular panel, but will not be used in the production report.

In order to improve precision of thickness and attribute calculations for the strata, the option is available to specify a grid file name instead of the average value. This allows the program to calculate the desired value on-the-fly based on the calculated perimeter. To use a grid, click on the attribute to change, then select "Grid" in the Value/Grid popup. Then either type the grid file name or select it using the File Select button and store the change using the Update button. Excessive use of grids in calculations will slow down your computations, so use judgment whenever it is necessary to select grids over value.

In order to make the assignment of the Difficulty Factor (to adjust equipment production rate) easier for large number of panels, the attribute named DIFFICULTY may be used instead of modifying every panel data. The corresponding name for retreat mining is RET_DIFF. Both grid and value attribute types are permitted.

These attributes are also used in Quantities by Average and Quantities by Grid functions to calculate qualities associated with the panels.
When you select **Keywords Help** the following dialog with keyword definitions pops up.

<table>
<thead>
<tr>
<th>KEYWORD</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>THICKNESS</td>
<td>Key strata thickness</td>
</tr>
<tr>
<td>DENSITY</td>
<td>Key strata density</td>
</tr>
<tr>
<td>ROCKTHICK</td>
<td>Non-key strata thickness</td>
</tr>
<tr>
<td>ROCKDENS</td>
<td>Non-key strata density</td>
</tr>
<tr>
<td>TIMESGRID</td>
<td>User-defined grid to use for timing</td>
</tr>
<tr>
<td>DIFFICULTY</td>
<td>Difficulty factor on advance (Underground)</td>
</tr>
<tr>
<td>RET_DIFF</td>
<td>Difficulty factor on retreat (Underground)</td>
</tr>
<tr>
<td>DIFF_BENCH*</td>
<td>Difficulty factor for bench * (Surface)</td>
</tr>
<tr>
<td>XXXX_BENCH*</td>
<td>User-defined XXX for bench * (Surface)</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Underground  
**Keyboard Command:** editpattr

### Assign Panel Attributes

The command allows for selecting multiple panels and assigning a Panel Attribute Group to them all at once. A typical use for this is where there are different sets of attributes used in different panels, such as a continuous miner and a longwall. These two different attribute groups must be defined first, in the Timing Project Manager, then they appear on the dropdown list of Attribute Groups to choose from. Choosing the button next to the group dropdown will bring up the Edit Attributes screen, where changes can be made if needed. Once the group is selected in the dropdown, choose OK and select all the panels to assign that group to.
Prompts

Select panel polylines to have attribute group assigned.
Select objects: 1 found, 14 total
Select objects:
Saving changes to project database...

Pulldown Menu Location: Underground
Keyboard Command: setpanelattr

Edit Panel Attributes

The function edits the panel attributes attached to a panel perimeter polyline. The list of attributes is loaded from a polyline or created anew using the Default Panel Attributes defined. The dialog used is the same dialog as in the Define Panel Attributes function. Edit Panel Attributes allows you to specify a distinct set of attributes for the particular perimeter polyline. This set has precedence over the default one.
Whenever the Edit Panel Attributes function is used to make changes in attributes for the particular panel, a completely separate set of attributes is created and stored for this panel. From that point on, the changes in default panel attributes will not affect this edited panel. To revert these changes and make the panel use the default set of attributes, use the Reset Panel Attributes function.

**Reset Panel Attributes**

Pulldown Menu Location: AdvMine
Keyboard Command: resetpanelattr

**Set Report Defaults**

Report Options. Each item on the dialog box is defined below.
• **Report by period:** This option runs the schedule and breaks the pits into blocks by period, such as month or year. The blocks and outlines are colored by period and displayed in the report. The report can be formatted many ways.

• **Report by equipment:** This option runs the schedule and breaks the pits into blocks by Equipment. The blocks and outlines are colored by equipment and displayed in the report. The report can be formatted many ways.

• **Report Only:** Choosing this option will not draw any blocks or outlines on the map. It will go directly to the Report Formatter for viewing of the data.

• **Draw blocks:** When this option is selected, the periods or equipment will be drawn as blocks of solid fill or any AutoCAD hatch pattern that is chosen.

• **Draw distinct outline:** When this option is selected, the periods or equipment will be drawn as closed polyline outlines.

• **Draw legend:** This option draws a legend and the picked location on the map. The colors are based on period, custom amounts or equipment.

• **Pastel colors:** Choosing this option draws the blocks or outlines in the pastel color region of the AutoCAD palette. It uses colors in the 11, 21, 31, 41 etc. row. If it is not selected, then it will use the brighter, primary colors such as 10, 20, 30, 40, etc.

• **Enforce custom colors:** Selecting this option will use the custom color palette the is setup with the Custom Dates and Colors Table.

• **Custom table: Dates/Colors:** This brings up the Define Ranges screen. This is where a custom date or color table can be set up. The Auto set button will bring up the smaller window for entering the starting line (row number), starting date, how often to repeat, and how long to keep repeating. The Set colors will prompt for a starting color, and the color number increment. The colors are set by picking the color box. The Pattern is the pattern of the hatch in the blocks. The Scale is the size of the hatch patterns if a hatch is used. The Layer is the AutoCAD Layer of the period. Finally, the Label is what each period will be called for reporting and labeling. The example shown here has created a weekly schedule with custom colors. The Clear button wipes out the data for starting over. The tables can be saved and loaded as CDT files. To use this option, choose Enforce Custom Colors or Custom Date Table.
**Custom table: Amounts:** This button brings up the Define Levels window. This is where the amount to target is set for the Custom Amounts option in the report. The amount to target is set in the first column. The next column is the color for the blocks and outlines. The colors are set by picking the color box. The Pattern is the pattern of the hatch in the blocks. The Scale is the size of the hatch patterns if a hatch is used. The Layer is the AutoCAD Layer of the period. Finally, the Label is what each period will be called for reporting and labeling.

![Define Ranges (Lowest to Highest)](image)

<table>
<thead>
<tr>
<th>Range</th>
<th>Date</th>
<th>Color</th>
<th>Pattern</th>
<th>Scale</th>
<th>Layer</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/1/2007</td>
<td>1/1/2007</td>
<td>SOLID</td>
<td></td>
<td>250.00</td>
<td>MINETM1</td>
<td>Week1</td>
</tr>
<tr>
<td>1/15/2007</td>
<td>1/22/2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2/12/2007</td>
<td>2/19/2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

![Define Levels](image)

- Define Levels window: This window allows for the customization of the levels in the report. The Amount column sets the amount to target for each period. The Color, Pattern, Scale, Layer, and Label columns provide additional details for each level.
• Change shade color every: This option will change the color/layer of each block or outline. There are 3 choices. Every Period (what is selected below), Year, or 5 Years.

• Block labeling: This pulldown is for setting the labeling options. There are 5 options here. No Block Labels will not draw any labels. Draw Actual Dates will draw the date of each period. Draw Period Names will place the period name in the block that is entered in the custom date table. Use Custom Names draws the names entered in the custom amount table. Use Custom Text Block activates the Add, Edit and Remove buttons. Choosing Add or Edit will bring up the input screen for arranging the text items in the block. First, give the new block a name. Then move items from the left side to the right, in the row desired. The Add Text button allows for custom text for prefix or suffix entry. The Add Attribute adds any attributes that exist in the schedule. Add New Line moves the added item to the next row. If this is not selected, then the next item is added to the same row, with a + as a separator. Remove will move the entire row from the Line definitions.

- Text Size/Text autosize: This will either place all text in the map with the defined size, or autosize it to fit in the block dimension.

- Length-wise labels: This option draws the text parallel with the long axis of the pits. If it is not selected, then the text will be 90 from the long axis.

- Text Style: Enter in an AutoCAD text style for labels.

- Text Block Style: This section is active if the Block labeling is set to Use Custom Text Block. Any premade blocks will appear on the list and may be selected for text orientation.

- Report Period: This is the start and finish date of the report. By default, the program will display the full range from the start date to the final date it needs to finish. Any date range in the middle may be used.

- Skip format prompt: If this option is selected, then after the blocks are drawn, a report will appear that is similar to the last one created. The program will not bring up the report formatter for customizing.

- Sub-divide by properties: If this is selected, the schedule will recognize any named Carlson property lines drawn on the mineplan. In the report, the periods can be further subdivided by property and owner. These are the same property lines that are used in Underground Mine Reserves.

- Output period grids: Choosing this option will create a grid file of the 3D surface at the end of each period. It needs the Surface Grid and the Bottom of Pit Grid. It needs at least the Bench 1 Grid filled in to make the grids. Finally, create a new output grid path with a prefix to create new grids of each pit. A new grid file is then written of each pit and bench. This can be an "ultimate pit" used in other design work. It doesn't have the flexibility of other commands such as Design Bench Pit. It uses a constant highwall slope of around 80 degrees. Disregard for underground mining.

- Period Polylines to Pits: Selecting this option creates and names the outlines as Carlson pits. The names of the pits are the actual period names. This is useful if these period polylines need to be saved and re-run in the Surface Mine Reserves for additional quantities or analysis. Disregard for underground mining.

- 12 months + 8 quarters + years: A schedule run with this option will break down the first year into 12 monthly periods, the next two years into 8, 3 month quarters, and the remaining periods will be full years.

- Show Months of Development: This method will use the starting day and increment by month to the same day. For example, if the starting day is on the 12th of each month, the schedule will be from the 12th to the
12th for each month.

- **Show 1st Days of Months**: This method will use the starting day and increment to the first of each month. For example, if the starting day is on the 12th of the first month, it will go to the end of the first month and then start fresh on the 1st of each month.

- **Show Years of Development**: This method will use the starting day and increment by year to the same day. For example, if the starting day is on June 15th, the schedule will be from June 15th to the next June 15th.

- **Show 1st Days of Years**: This method will use the starting day and increment to the first of each year. For example, if the starting day is on June 15th, it will go to the end of the first year and then start fresh on the 1st of each year.

- **Show Date Range**: This option is used to just display a period as a partial range. Enter a range above in the Report period windows. Then when the sequence is run, only that period will be hatched all in the same color and time.

- **Custom Date Table**: When a custom Date/Colors table is defined, this option must be selected to use it. Custom Dates/Colors are defined above.

- **Custom Amount Table**: When a custom Amount table is defined, this option must be selected to use it. Custom Amounts are defined above.

- **Legend Scale**: If the Draw Legend box is selected, this is the size of the legend. Sizes from 50-100 should appear legible for most mine plans with a dwg scale of 50.

- **Hatch**: This is the hatch that is used for drawing in the blocks if the custom date or amount tables are not used. All hatch patterns appear on the list, the most common one, solid, appears at the top of the list for easy selection.

- **Retreat Hatch**: This is used for underground retreat hatching. This provides the user the opportunity to create a different pattern for second mining than advance. Note that longwalls are treated as mining on the advance.

- **Divide advance/retreat display**: This divides the advance and retreat mining hatches and splits the panel to display both. Note if you use this option it splits all panels regardless of the presence of retreat mining in a panel.

- **Scale**: If a hatch pattern other than Solid is used, this is the scale it will be drawn at. Sometimes trial and error is needed to get the best scale, as different patterns look better at different scales.

- **Layer**: This is the AutoCAD layer that the blocks and outlines will be drawn in, if no other options are used.

- **Layer by year**: The blocks and outlines will be layered by year. The year will appear as a suffix to the layer name.

- **Layer by period**: This option will put each period on its own layer. If there are many periods, it will create many layers which can be a hassle.

- **Of, Sum for whole mine & Stop at last period**: These options are only active when using the Custom Amount Table. The "Of" window is for selecting what is being target for custom amounts. The options are similar to Surface Production Timing: Total Tons, Key Tons, Waste Tons, Total Area, Mined Area, Total Volume, Waste Volume, and User Grid. Sum for whole mine will keep a running total for summation in the report. Stop at Last Period will end the schedule at the last entered row in the Custom Amount Table entered above.

**Pulldown Menu Location**: AdvMine > Underground, Adv Mine > Surface

**Keyboard Command**: set_report

---

**Subdivide Panel**

The simple way to specify different coal qualities and/or other panel properties is to break a large panel into a number of smaller sections. These sections are later associated with a single panel within the Place Panel routine. This routine divides panels into a given number of smaller ones. The slower alternative to this method, giving better precision, is to use grids instead of average values for panel attributes.
Pulldown Menu Location: AdvMine
Keyboard Command: subdivide

Place Panel
The Place Panel function requires a panel perimeter drawn in the PERIM layer. If you draw the panel with Advanced Projections in the Basic Mining Module and use the option to draw the pillars, the program will automatically calculate the extraction ratio (as shown in the example panel on the left). The extraction ratio can be entered into the Edit Section dialog box, if you start with the perimeter only drawn in the PERIM layer (as shown in the example panel outline on the right).

Place Panel Pre-Requisite Linework Options

The underground timing routine operates with a tree-like structure of the panels built using a centerlines network. The new panel may be added or an existing panel (i.e. created using Advanced Projections) may be attached to the existing network of centerlines using this function.
Each panel may consist of a number of sections, where each section is characterized by the uniformity in the section attributes such as owner, coal thickness and qualities, complexity of mining, extraction ratio, azimuth and length. Therefore each panel is represented by a centerline and a set of panel perimeter polylines, one for every section.

Due to the tree-like structure of the Mine Plan, each new panel should branch from the existing panel. This allows for proper timing calculations and data management. The user is prompted for the starting point and direction of each section, with dimensions dependent on the existing perimeter polyline or on user input.

If an existing polyline is used to define the panel, the program evaluates the section length by intersecting the centerline with this polyline. Otherwise the sizes of the section are defined in the Edit Section Dialog. The appearance of the dialog depends on the way the section is defined. Both kinds of dialogs are shown here.

User has a number of options to define a direction of the panel. The following methods are available:

**Perim:** The direction of panel is defined by the direction of the first segment of polyline.

**Text:** Direction is from "branch off" point to insertion point of the text found inside the panel. The text must be in PANELNM layer and it defines panel name.

**Pick:** Direction of the panel is from "branch off" point to pick point.

**Segment:** Direction is defined by user-picked segment of the panel polyline.

**Panel name:** Identifies the panel for Underground Timing.

**Difficulty factor:** Represents the effectiveness of the mining equipment within the section. Values above 1.0 will cause proportional slow down of the production and below 1.0 will speed it up. This value may be specified using difficulty factor grid file by selecting file with Select File button or typing it in instead of the actual value. The run-time difficulty factor will then be evaluated for corresponding area.

**Precedence:** Defines whether development of the section may not start until all listed sections are completed. Precedence is especially important for the longwall sections, since production there is not possible until all headings are completely developed. The listbox shows panels which have to be developed before the section being edited. Since some sections may be defined after the current section, it is advisable to edit precedence later with Edit Panel function. The precedence can be set by either picking from the list, or screen picking.

**Panel start:** Defines fixed start date of the development. This field is optional and is ignored if the actual starting date is later than date specified.

To define attributes for this panel section (such as THICKNESS, DENSITY and etc. as explained in Define Panel Attributes function) select Prompt for coal qualities toggle.

In the case of using an existing perimeter, the extra unknown is Extraction Ratio, whereas in the other case the dimensions of the section and entry/crosscut spacings need to be defined. The extraction ratio will default to value calculated using pre-drawn pillars and panel perimeter.

The **Entry Width** for predefined panel is only used if the section is mined by the piece of equipment with the linear feet of advance production rate specification.
Retreat Extraction: Defined as ratio of area of all coal extracted on retreat to the area of whole panel. Therefore if extra side coal is picked up on retreat this value combined with advance extraction ratio, exceeds 1.0. To simplify estimation Prompt for retreat options may be used to calculate the retreat extraction for given the extraction polyline.

Retreat Difficulty Factor: Similar to Difficulty Factor except it applies on the retreat stage.

Users who are creating an extensive mine plan, may prefer to use a streamlined Quick-Place mode to create layout and later on use Edit Panel Dimensions to modify panel properties.

Prompts

Use Quick-Place mode (Yes/No)? press Enter
Start new Mine Plan (Yes/No)? press Enter Choose Yes to start Mine Plan.
Select an entry to branch from: pick the panel to branch from at desired location
Enter the azimuth for the segment:
Select a panel polyline or press Enter for dialog:
Edit Section Dialog
Enter the azimuth for the segment:
Select a panel polyline or press Enter for dialog:
Edit Section Dialog
Pulldown Menu Location: AdvMine
Keyboard Command: place_panel

Pick & Place Panel

This routine is parallel to the Place Panel and Underground Timing functions. The timing through the panels is performed as soon as the user picks the panel perimeter. The sequence of picking and all the associated parameters necessary for "replay" are stored in the same form as with the Timing routine. That allows you to modify the mine plan, equipment rates and/or calendar and obtain an updated plan without having to redo the sequence.

The routine goes through the following steps:

– Prompt user for next panel to mine in.
– Check if the picked panel is a part of the mine plan already. Then prompts to pick an existing mine plan or to start new mine plan. The existing plan is loaded in and rerun to obtain the information about the availability of the equipment.
– Bring up the dialog and prompt the user for various parameters and the part of the panel to be mined. The proposed mining is previewed along with the dates and tonnages associated with the proposed segment.
– When editing is finished the colored and labeled timing blocks are displayed in the user-defined style and the whole process is repeated for the next panel.

The starting date of mining in the picked polyline depends on three dates: if the optional panel start date is specified and the unit is available this date is used. Otherwise if the unit is tied up within some other panel, the starting date is the date when the unit finished the last panel offset by the specified moving delay. Lastly if the unit has not been used in the mine plan at all, the start date for the panel is the same date as for the whole mine plan.
The portion of the panel to be mined is determined by the selection made:

**Whole perimeter** The panel will be mined to the end of the panel or to the next pin point if present (retreat).

**Distance** Mining will advance a given distance along the centerline past the last mined point. Use of this option on retreat is associated with automatic reassignment of advance development, followed by rerun of timing plan (advance and retreat use the same set of pin points).

**Period** and **To Date** are similar to Distance, since the program will automatically calculate a distance corresponding to given date.

When the **Test** button is used the portion to be mined is highlighted in the drawing and the timing and quantities results are displayed in the dialog.

The amount of time necessary to mine given portion of the panel depends on the following factors:

- Equipment production rate (use Define Equipment to modify)
- Coal and Rock Attributes (Define Panel Attributes, Edit Panel Attributes)
- Difficulty Factor (may be specified as value or grid on per panel basis or using Define Panel Attributes and by placing a text labels on certain layer within the panels)
- Extraction Ratio (pre-calculated based on pillars draw inside the panel, but may be modified) Equipment Calendar assignments.

**Report Options** are the same as these used in Underground and Surface Timing Routines. The final results for the portion laid out during current session are displayed in the user-defined form using the Report Viewer.

The generated mining plan (the system of green centerlines) may be modified and rescheduled using Underground Timing routine.

**Pulldown Menu Location:** UnderGnd

**Keyboard Command:** pick_panel
Auto Place by Text

This is the best method to place many panels fast. The panel is directed by text orientation with centerline going through text insertion point. The text itself becomes a panel name and it has to be in layer PANELNM to be found. User can specify retreat options, difficulty factors and entry width to be used for all panels before running command. To place the text in the panels easily use Draw Sequential Numbers, found under the Draw dropdown menu.

All panels created in one run become a single connected mine plan with no equipment assigned.

When you note the prompts below for entry width you will want to place the "longwall panels" and "room and pillar" works in two steps in order to get the correct advance distances reported. For this example the room and pillar works are on 20ft width, and the longwall width is 1,000 feet. Placing them in two steps will create two mine plans that can be connected using the Connect Mine Plans option.

Chapter 15. Underground Mining Module
Prompts

Assign zero retreat extraction [Yes/No]? Y

Advance difficulty <1.0>: 

Entry width <20.0>: Use the panel width for longwalls, entry width for room and pillar panels.

Pulldown Menu Location: UnderGnd
Keyboard Command: auto_place

Edit Panel

The function is identical to the section definition portion of Place Panel function. It is used to edit properties of the section of the panel after the panel has been completed. The precedence can be set by either picking from the list, or screen picking.

- Panel name: This is a required field.
• **Panel start**: This is an optional field. The Underground Timing routine have an option for start date that usually makes this field unnecessary. This field can delay the start of a panel independently of the plan start date.

• **Easting**: The easting coordinate value of the first picked point when the panel was placed.

• **Northing**: The northing coordinate value of the first picked point when the panel was placed.

• **Azimuth**: The azimuth from the first to the second picked points when the panel was placed.

• **Entry Width**: This is used to calculate face feet/meters of advance. This should be set to the width of the panel when working with longwall panels to get the correct advance down the panel.

• **Prompt for coal qualities**: A check in this box brings up the Define panel Attributes dialog box.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>THICKNESS</td>
<td>5.0000</td>
<td>Value</td>
</tr>
<tr>
<td>DENSITY</td>
<td>88.0000</td>
<td>Value</td>
</tr>
<tr>
<td>ROCKTHICK</td>
<td>0.5000</td>
<td>Value</td>
</tr>
<tr>
<td>ROCKDENS</td>
<td>155.0000</td>
<td>Value</td>
</tr>
</tbody>
</table>

• **Prompt for retreat options**: The following prompts appear that allow for a second polygon that specifies a second area that can be retreat mined separate from the area mined on the advance. This additional polyline must be closed and can be totally contained in the advance polyline, overlap, or be outside. When the polyline overlaps two options exist: the extraction ratio for the area contained in the advance polyline and the area outside of the advance mining polyline.

**Command Line Prompt:**

- Pick a polyline representing a shape of the retreat area:
- Enter the extraction ratio for remaining pillars: .25
- Enter the extraction ratio for COAL outside the panel: 0

• **Retreat Extraction**: Any entry in this box other than the default zero will place a second mining panel that can be scheduled on the retreat back through the panel.

• **Owner**: A single owner's name can be assigned to the panel.

• **Precedence**: This box gives the opportunity to set fixed scheduling relationships. Any panels selected must be completed before this panel can start.
• **Advance Difficulty Factor:** A value or a grid can be used to provide difficulty factor input for advance mining in the panel.
• **Retreat Difficulty Factor:** A second value or grid can be specified for retreat mining independent of the advance mining difficulty rate.

**Pulldown Menu Location:** UnderGnd  
**Keyboard Command:** edit_panel

**Update Edited Panel**

The mining plan created once should undergo changes as mining progresses. The user may modify, replace or erase panel perimeters in correspondence with changes in the existing mine and then use this command to update the mine plan data. Do not modify or erase the remaining linework, since this linework and internal plan data will be updated to match changes in the associated perimeters. This command should also be used every time the panel polyline is moved, replaced or edited for any other reason.

Naturally the mine starting date should be moved forward each time plan is updated, so that timing of the remaining plan remains correct.
Once the panel linework is updated, re-run the Underground Timing updating the plan start.

**Pulldown Menu Location:** UnderGnd  
**Keyboard Command:** update_plan
Recalculate Extraction

When changes are made to the panels that result in a change in the extraction ratio this function must be run to update the extraction ratio in the panels. This also must be run after placing panels using Auto-Place Panels by text. If the text values for extraction are used to input the extraction ratio for advance or retreat extraction ratios this function must be run. Text for the extraction ratio must be put on the CAD layer of EXTRACTION. Two other layer names that will be recognized by this command to update the panels are ATTR_GROUP to assign a certain Panel Attribute Group to certain panels (such as longwall vs. continuous miner), and ENTRY_WIDTH to set that to the value of the text in that layer.

Prompts

Select all panel polylines to have extraction ratio updated:
Select objects: Specify opposite corner: 6 found
Select objects:
Polyline offset amount <0.0>: press Enter
Retreat recovery <1.0>: 0

Panel 5 RIGHT has extraction of 0.48000
Panel 4 RIGHT has extraction of 0.48000
Panel 3 RIGHT has extraction of 0.48000
Panel 2 RIGHT has extraction of 0.48000
Panel 1 RIGHT has extraction of 0.48000
Panel N MAINS has extraction of 0.55000

Pulldown Menu Location: AdvMine
Keyboard Command: redoextract

Find Panel

Use this command to find a panel with a given name in a complex mine plan. Type the name of the panel in at the command prompt and the ghosted dashed arrow will appear in the center of the screen pointing at the requested
The mine plan consists of visible linework and internal data, including cross-references, containing all data necessary for timing. For this reason a simple deletion of the linework of an unwanted panel is not enough for removing all references to it and is likely to corrupt whole mine plan.

Use the Remove Panel command to remove all the linework and clean up internal data related to panel being removed and all its children panels.

In case if user just wants to remove a panel, but keep its children in the mine plan, remove a panel perimeter polyline and then use Update Edited Panel to tell it what that panel is completed.

Connect Mine Plans

Two mine plans which are located in two separate parts of the mine but are sharing the same equipment or just wanted to appear on the same time plan, may be connected into a single mine plan using this command. The only difference between joint mine plan versus conventional one is that mining progresses simultaneously in all connected plans, if equipment use permits that.

The following drawing contains two separate mine plans: Plan A and Plan B.
Plan A panels are shown when the Underground Timing function is selected. (Before connecting)
Panel B panels are shown when the underground timing option is selected and you pick on the Plan B panels.

(Before connecting)

After connecting Plans A & B the list of available panels is composed of both lists.

Pulldown Menu Location: AdvMine
Keyboard Command: connect_plans
Disconnect Mineplans

A mine plan is a group of placed panels on a common list grouped together for scheduling. Disconnect Mine Plans is used to break a mine plan into two or more groups of placed panels. To select a mine plan pick on the green backbone lines of the placed panels.

Prompts

Select a part of the mine plan to be disconnected: select backbone polyline
Select a part of the mine plan to connect to or press Enter to leave disconnected: press Enter

Pulldown Menu Location: AdvMine
Keyboard Command: disconnect.plans

Add Pin Point
Pin Points are used to provide stopping points within a panel. This is similar to, but not exactly the same thing as sub-dividing as panel. Pin Points can be used to sequence mining up to the stopping point for both advance and
retreat mining. Difficulty factors can be changed between pin points by placing the difficulty factor by text on the DIFFICULTY layer to impact the mining rate as well. Units can mine up to a pin point, mine in another panel, and then return to continue mining later. The N_Mains panel below has been broken into 6 parts that can be scheduled with the 5 pin points as shown.

The function Add Pin includes new pin points into the panel as desired.

For the example shown the sequence of advance mining is as the following:

N_MAINS <B:1>
N_MAINS <1:2>
N_MAINS <2:3>
N_MAINS <3:4>
N_MAINS <4:5>
N_MAINS <5:E>

The different pieces may also be assigned to the separate units as well.

The same set of pinpoints is used for both advance and retreat mining with the following naming convention:

Advance
N_MAINS <B:1>
N_MAINS <2:E>

Retreat
MAINS<B:1>
RET MAINS<2:E> RET, so that a section name on retreat is the same as on advance except for suffix the RET.

Prompts

Select a position for pinpoint: pick the desired location on the centerline
Remove Pin Point
The Remove Pin Point command deletes the unwanted pin point from the panel. See Add Pin Point for detailed information on pin points.

Prompts
Click on centerline close to pinpoint to be removed: *pick on the centerline close to unwanted pin point*

Set Current Position
The purpose of this function is to set the current state of the mine development.

When a mine plan is first created, the mine plan is a snapshot of the layout of the mine. As mining progresses some panels are completed, while mining in the others just starting. Whenever the user wants to advance the Starting Date, the mine plan should be adjusted to the mine state on the new date.

Some of the updates can and should be done using Update Edited Panel after corresponding modification, but whenever a panel is going to be retreated, it is impossible to modify panel perimeter to show changes. In this case a current position of the crew within the panel is marked using Set Current Position function.
Prompts

Select a current stage of panel development (Advance/Retreat)?
Click on centerline at current position: pick on the centerline

Pull Down Menu Location: UnderGnd
Keyboard Command: pstart

Panels Report

Panels Report provides a way to report out all of the information stored in the panels in a common mine plan using the report formatter. Select any backbone polyline in a mineplan and the report formatter will appear ready to print the report.
Underground Timing

The diagram above shows the general steps associated with the creation of a mine plan with the Underground Timing routine. Pre-requisites include:

- Creating thickness, density, and quality grids, and/or average values for the total coal and rock to be mined.
- Define the productivity rates of the equipment and operating schedule for each section of equipment.
- The drawing linework has to be prepared on specific layers.
- Panels can be placed using one of, or a combination of, three placing routines: Place Panel, Auto.Place Panel by Text, and/or Pick and Place Panel.
- Several adjustments to the mine plan can be by Adding Pin Points, Recalculating Extraction, Connecting Mine plans, and Editing panels.
The drawing above shows the North Main panel with 5 panels to the right. The panel perimeters are drawn on the PERIM layer. The panels in this example were placed using Pick and Place.

The Mining Project dialog box above shows some of the key files used in the mine timing. Options on the right side become active depending on the items selected on the left side.
The underground timing scheduling dialog box provides options to assign panels to be mined to the equipment, insert delays between panels, input the plan start date, number of shifts/day, and undo the current report. Disregard the bottleneck options for underground mining. The underground timing routine calculates the time needed to complete the assignment, calculates coal quantities and qualities, draws results period by period, and produces a production report. In the order to calculate timing, every panel needs to be assigned to equipment. The left listbox lists the available equipment. Use Add button to create a new equipment or edit to change the definition of the defined one. This list is stored within the mine plan and is different for every plan. The Edit button calls the same dialog as the Define Equipment function.

The middle listbox shows panels currently assigned to the crew highlighted in the left listbox (if any). To assign a panel to the equipment, first click on the equipment name, then on the panel name in the right listbox and at last on the Assign button. Panels are mined in the same order as they appear in the list. To complete mining of all assigned panels successfully the order should not be controversial (i.e. NMAINS <1:2> can not appear before NMAINS <B:1>). To change sequence of mining click on the desired panel name and use Do Earlier or Do Later buttons to change the order. The Remove button removes the highlighted panel from the list of the panels assigned to the current crew and moves it to the right listbox. Use Add Delay button to add delay (for moving of equipment, maintenance or other reason) after highlighted panel. After all panels for first crew has been added click the next crew and repeat until all the panels needed are added.

Screen Pick will allow for selecting the panels graphically on the screen. Each panel is hatched with solid fill to give instant feedback that the panel has been assigned. If pin points are in the panel, it will only hatch up to the next pin point, allowing the panel to be assigned in order as separate entities.
When the assignment is completed click the Calculate button. Check the timing report produced and make sure that all assigned panels have been developed. If the process terminates earlier, the rest of the plan was inaccessible for some sequencing reason. Modify the assignment if needed and click Calculate again. During retreat mining it is possible that a sub-panel will be completed later that the panel itself. If this conflict occurs the calculation algorithm will try to offset start date of the panel itself to get timeout sufficient to resolve the problem. In the case when a problem could not be resolved an alert box with corresponding message will appear.

The time needed to develop a panel is offset by the Extraction Ratio and Difficulty Factor defined in the Edit Panel Dialog, and thickness and density of coal and rock defined by the Edit Panel Attributes function. The presence of qualities in the production report depends on the list of panel attributes and their values defined by the Edit Panel Attributes function.

In cases when the mine plan includes retreat (second) mining, the system will make sure that when the parent panel is mined on retreat, the mining (advance or retreat) in all child panels is completed. If not it tries to offset the starting date of retreat in the parent panel until the timing conflict is resolved. Sometimes it is impossible to do so and program reports the problem to user for manual resolution.

![Image of Report Options dialog box]

**Reporting Options**
• **Report by period** - To draw the development progress period by period and to obtain quantities and qualities report click on this button. The Report options dialog appears prompting for drawing options and period sizing.

• **Report by equipment** - use different colors to distinguish pieces of equipment not periods.

• **Report only** - skip any drawing, just generate a detailed report.

### Period Sizing

The available period sizing options are:

- **12 months + 8 quarters + years** - Display monthly development for one year, followed by quarterly periods for next 2 years and from then yearly periods;

- **Months/Years of Development, 1st Days of Months/Years** - starting from specified period start date display each Month/Year of development, optionally with rounding start date to the first day of the Month/Year.

- **Custom Date Table** - Completely user-defined sequence of periods, with customized dates, colors, layers and hatches.

- **Show date range** - Display a single period as specified by user.

- **Show custom table amounts** - The same purpose as the previous selection, with ability to specify different amounts and drawing attributes for every period. Option *Sum for whole mine* controls whenever equal quality should be mine from whole mine or from the single panel.

### Text Block Labeling Options

- Text labels are usually drawn perpendicularly to panel scaled to fit into the period area. This behavior may be modified by clearing *Text Autosize* option to have fixed text size and/or by selection *Draw labels lengthwise* to change orientation. User may pre-define a custom text style and specify it in *Text Style* field. User is also able to define a completely custom text block to be used for labeling which may have any information present in the report later as well as any extra text to be displayed. Several named label blocks may be defined.

- **Block Labeling** pull-down defines what is displayed as period name in timing block drawn.

- **Draw period names** option uses short one line name for the period,

- **Use custom names** picks up the name from custom date table.

### Hatching Options

- Three different, user-definable hatches are used for advance, retreat and predefined mine history.

- The layer name for the retreat mining is obtained by prefixing "RT-" to advance layer name.

- **Enforce Custom Coloring Table** option allows to use any period sizing in combination with Custom Date Table defining colors, hatches and layers for every particular period.

- **Change Shade Color** pop-up box controls rotation of color depending on the period drawn.

- **Use Pastel Color** enables use of larger number of colors for drawing timing blocks.

### Using Property Boundaries

*Sub-Divide* by properties controls whether system tries to use property lines and do calculations on per property basis.

### Other Output Options

- **Sum For Whole Mine** toggle defines if for period sizing by amount options the amount is a total for a whole mine or just for each panel.
- *Report Polylines to Pits* enables use of drawn period boundaries as "pits" for calculations using Mountain Top Removal.

- *Output Period Grids* - in surface mining stores current surface grid for each period. This grid sequence may then be played back using View 3D GRid History command.

- *Divide Advance/Retreat display* draws advance coloring to the right of centerline and retreat one to the left.

- *Layer by Year/Period* - place coloring for the same year/period on the same layer.

- *Stop at Last Period* - when using custom period table stop timing at last period defined

When the Custom Date Range option is selected date ranges are displayed similar to that above. The colors/dates table shown defines color/layer/label combination for a specific date range. The Auto Set function may be used to fill out the table for repeating period lengths starting at a particular line and to create a complicated setup like 12 months + 4 quarters + years after.
Date ranges can be automatically set with the dialog box above.

If development progress drawn is not satisfactory and the scheduling needs to be adjusted, use *Undo Report* button in Timing dialog to remove drawn report entities. After the dialog is completed, the mining development is shown step by step and then the coal production report is generated. The report format may be modified to suite the particular need and preferred format saved for further use. See Reference Manual for complete description of Report Formatting dialog. There is a progress window displaying the time elapsed and the time remaining for large schedules that require a lot of time.
The Report Formatter has several output options:

- **Report** - This outputs to an ASCII text file viewer and an ASCII text file can be saved or inserted directly into the drawing.
- **MS Excel** - Exports the report directly to an MS Excel spreadsheet.
- **Import/Export** - Has several options to move data in and out of your reports, and you can export to an MS Access mdb file.

**Report**

The Report tab outputs ASCII text reports as shown below:
The above report is an example of an Ascii text report in Non-columnar format.

<table>
<thead>
<tr>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Start Year</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>8/17/2007</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

The above report is an example of a columnar Ascii text report.

Chapter 15. Underground Mining Module
The report above is an example of an Ascii text report in spreadview.

The User Defined Attribute tab leads to a dialog where custom attributes can be created.
The Attribute options opens with a list of the attributes above, providing display and formatting options below.

MS Excel
When the MS Excel tab is open reports can be exported directly to new or existing spreadsheets, beginning on any specified sheet, row and column. There are also options to include totals and text header information in the file. When the options have been specified click on the *Export to Excel* button. The spreadsheet below was exported using this option.
At the Export button under Import/Export tab there are 5 options shown above.

Rpt format reports can be merged together, as shown above. The rpt reports are the reports that can be loaded and viewed even after the underground timing routine is closed.

Prompts
Select any part of mine plan: Pick any centerline in the mine plan

Underground Timing Dialog

Pull-Down Menu Location: AdvMine

Keyboard Command: schedule_mine

Clear Timing Report

Removing the coloring after the timing routines are completed may be a tedious task. This routine removes and erases all text labels and hatching from surface pits and underground panels for a specific bench or mining direction in one step. It is a quick and efficient procedure, even for objects on many layers. Items are permanently removed from the drawing screen. It supports both surface and underground mining.

Prompts

For Underground Timing:
Remove coloring for [Advance/Retreat/<Both>]? 
Select parts of mineplan to have timing coloring removed:

The following drawings show panels with blocks colored and without blocks colored after using Clear Timing Report.
Subsidence Menu

The subsidence routines work with the SDPS (Subsidence Deformation Prediction System) program. SDPS was written by Virginia Tech. Carlson Software is the exclusive reseller for SDPS.

**DXFOUT Mine Plan to SDPS**

This command creates a DXF file to import the mine plan pillars and perimeter to the Subsidence Deformation Prediction System program. The pillars and perimeter polylines created in Carlson with the layers PILLARS and PERIM. The PERIM layer is written to the DXF file as PANELS for SDPS. This routine provides the user the ability to specify the direction the pillar polygons are drawn. SDPS requires the pillars to be drawn in the counter-clockwise direction. For additional information on this procedure, refer to the SDPS manual.
Prompts

**DXF File for SDPS** Enter a file name. The default directory is the SDPS directory defined in Configure.

**Pulldown Menu Location:** Subsidence  
**Keyboard Command:** sdpsout  
**Prerequisite:** Polylines in the PILLARS and PERIM layers and prediction points on the POINTS layer, if prediction points are input.

**Prediction Point Output**

This command draws text at each prediction point of the subsidence, strain and other SDPS deformation output values. From the dialog, click the Select button to choose an SDPS project file. The program then reads the values from all the output .dat files and labels the values next to the prediction points.
**Pulldown Menu Location:** Subsidence  
**Keyboard Command:** sdpsout  
**Prerequisite:** SDPS output files

## Post-Subsidence Contours

This command creates surface contours after accounting for subsidence. The surface is defined by prediction points which are POINT entities with the elevation of the surface. These points are then exported to the Subsidence Deformation Prediction System program which calculates the subsidence at each point. This subsidence output from SDPS is written to a DAT file in the SDPS directory. Post-Subsidence Contours then subtracts the subsidence values from the file from the elevation of the prediction points.
Prompts

Triangulate & Contour dialog
Select the prediction points.
Select objects: *pick the points*
Select SDPS Output file Choose the subsidence output file.

Pulldown Menu Location: Subsidence
Keyboard Command: sdpsectr
Prerequisite: prediction points and subsidence output file

Contour SDPS Output File

This command creates contours of the values in SDPS output DAT files. The output files can represent subsidence, strain and any other SDPS deformation output.
Prompts

Triangulate & Contour dialog
Select SDPS Output file Choose the output file.

Pulldown Menu Location: Subsidence
Prerequisite: SDPS output file
Keyboard Command: sdpsctr2

Draw Subsidence Profile
This command draws a subsidence profile created by Profile Function Formulation in SDPS. The profile data is stored in a .dat file that is created with the Output>Export option in SDPS.
Prompts

Subsidence Profile to Draw Choose the .dat file from SDPS.
Draw Profile dialog You may want to change the vertical scale to a smaller number to exaggerate the vertical.
Bottom elevation of profile grid < -4.0 >: press Enter
Pick Starting point for axis < 5000,5000 >: pick a point in a clear area of the screen

Pulldown Menu Location: Subsidence
Keyboard Command: sdpsprof
Prerequisite: Subsidence output file

Suggested Standards

Adjacent Mining
Layer: ADJACENT
Color: Blue (5)
Line Type: Continuous
Line Width: 0
Text Height: 20
Text Style: Roman
Text Font: Roman

Barrier Lines
Legend
Layer: LEGEND
Color: White (7)

Line Type Scale
Command: LTSCALE
Scale: 100

Mine I.D.
Layer: MINEID
Color: White (1)
Text Height: 10
Text Style: Romanc
Text Font: Romanc

Mine Name
Layer: COMPANYNAME
Color: Blue (5)
Text Height: 15
Text Style: Romanc
Text Font: Romanc

Mining Limits
Layer: LIMITS
Color: 30
Line Type: Border
Line Width: 4
Text Height: 20
Text Style: Romanc
Text Font: Romanc

N - E Line
Layer: N-E-LINE (Goes into the current layer)
Color: Cyan (4)
Text Height: 8
Text Style: Romanc
Text Font: Romanc

North Arrow
Layer: NORTHARROW (Goes into the current layer when inserted)
Color: Varies

Big Mountain
Leaf Mine
M.S.H.A. I.D. NO. 12345
98760
Chapter 15. Underground Mining Module
Chapter 15. Underground Mining Module 2769
Case Studies

Case Study #6: Underground Mine Layout and Timing

**Underground Project Manager**

The Underground Project Manager (MPD) file should be defined before stating with Underground Mine Layout and Timing using the Underground Project Manager command under Underground menu. It allows user to define Equipments, Timing Calendar, Panel Attributes as well as other essential parameters to be used in the timing.

![Mining Project: C:\Carlson2007\Data\Ugsection.mpd](image)

**Mine Layout Options**

Using the Advanced Projections command in the Basic Mining Module, there are several ways the user can generate mine projections. These different techniques will be based upon personal preference and management's direction. Whether or not to include the centerlines, pillars, and perimeters on the map are up to the user. The Advanced Mine Module timing routines require that some information is kept on specific layers. The pillars must be drawn on the PILLARS layer and the perimeter of each section must be drawn on the PERIM layer. These are the defaults set in the Advanced Projections option under the Basic Mine Module.

Choose the Advanced Projections command under Works. The first three prompts are:

1. Starting point of the belt
2. Number of entries to the left of the belt
3. The number of entries to the right of the belt

After responding to the initial prompts the Panel Settings dialog box appears. This dialog box allows the user to specify how the mine projections will be drawn. Several different variations are possible. Entry spacing and length can be varied, separately or together.
A nice feature of Carlson is that it allows the user to draw the rooms on one or both sides of the panel at the same time the panel is drawn. The rooms perimeter on the left or right side can also be joined to the panel perimeter so the timing blocks will match for the panel and the rooms.

In addition to the configuration of the pillars, the user has the option of what to display, pillars, centerlines, perimeter, as well as chamfer, angled blocks, bracketed pillars, stoppings, and ventilation.
As you can see there are several options to present mine projections with Carlson.

Once the panels have been laid out, they have to be "placed", or have extended entity data attached to them, so that they will relate to each other. Carlson has three different methods of placing panels: Place Panel, Pick & Place, and Auto Place by Text. Of these three techniques only Place Panel builds a network topology, or precedence relationship, between the panels as they are placed. With the other two techniques, Pick & Place and Auto Place by Text, there is no relationship built as they place the panels. This allows the user to actually mine through panels that overlay each other, which could be helpful in laying out mining through overlying strata.

**Place Panel**

To place panels, the panels must be previously drawn with the perimeter drawn in the PERIM layer and the pillars, which are optional, drawn in the PILLARS layer. The program subtracts the sum of the areas of the individual pillars in the PILLARS layer from the area of the perimeter drawn in the PERIM layer to calculate the extraction ratio. The extraction ratio is then applied to the perimeter area to calculate the tonnage in the panel.

In the Advanced Mine Module under the Underground dropdown box you will find Place Panel. When the user selects Place Panel the first prompt is:

**Use Quick Place mode (yes/<no>)?**  Quick place mode is an option that lets the user place panels without entering specific information in the panels other then the panel name. It is a way to get the panels placed quickly. If the user has drawn the pillars and does not intend to retreat mine, the Quick Place mode may be the best way to get the panels placed.

If the user chooses the Quick Place mode the following prompts appear:

**Start new mine plan? (yes/<no>)?**  The user will always respond with yes for the first panel. Next, as long as the panels being placed are adjacent, the response is negative. Panels that are part of the same mine plan, but are physically separated can be placed as new mine plans and connected later.

The next prompt is: **Direction of panel is defined by (<Perim>,Text, P1ck, Segment)?**

- **Perim** - The user defines the starting side of the polygon and the direction of mining is perpendicular to the first side of the polygon. If the panel is laid out using the Advanced Projections in the Basic Mining Module the perimeter is automatically drawn to match up with the requirements for the Perim option.
- **Text** - The direction of mining through the polygon can be set by the direction of the text.
• **Pick** - The user chooses two points to set the direction of mining in the reverse order of mining. The first point is picked inside the polygon, the second point is picked on the beginning side of the polygon. The direction is from the beginning side through the first point picked inside the polygon.

• **Segment** - Pick the starting side of the polygon and any side that parallels the direction of mining of the panel.

When the direction of mining has been set. The program prompts for the name of the panel, offering a name that can be accepted or overwritten. When the name is entered, the program draws the green "backbone" line according to the direction of mining and places the name of the panel at the beginning of the line. The user clicks the right button to complete this process for mining straight through a panel.

To mine around a corner the user left picks the mouse button and repeats the above steps for setting the direction.

Once the panel has been placed, the program prompts the user for the entry to branch from. The program is asking for the point along the "backbone" line to start the next panel. Once the user selects the starting point for the next panel the process repeats.

Using the Quick Place mode does not give the user access to the Edit Section Data dialog box during the panel placing process. If the pillars are not drawn when using the Quick Place mode the user will have to return to the Edit Section Data dialog box to enter the extraction ratio after placing the panels. Most users prefer to enter this information when the panel is being placed, so they usually do not use the Quick Place mode.

If the user chooses not to use the Quick Place mode there are two additional panel direction options available: Azimuth and Pick internal point.
**Pick and Place**

Pick and Place places and times the panel as it is placed, drawing the timing blocks when the panel is placed. In addition to timing as it goes, this option allows the user to test the schedule before placing the panel in the mining sequence, providing real-time feedback while scheduling the mine. This technique does not automatically build precedence between panels automatically. Precedence can be added to the panels in the precedence part of the Edit Section Data dialog box. Once all of the individual panels have been placed, the user runs the schedule to get the complete mine timing report.
Similar to Place Panel, Pick & Place Panel has the following options for specifying direction of mining. They are defined above:

- **Perim** (default)
- **Text**
- **Pick**
Once the direction has been set, the Define Timing Step dialog box appears.

- **Panel Name** - is a required field. The program will offer a name which can be overwritten.
- **Panel Start** - is an optional field.
- **Owner** - is an optional field, if filled out indicates the property owner for the entire panel and will be available in production reports.
- **Starting Date** - is not optional for the first panel assigned to any unit. After the first panel this field is optional and will be calculated.
- **Number of shifts** - is a required field, and overwrites the setting in the equipment definition file if the shifts are less than the equipment file.
- **Retreat Recovery** - If recovery is different on retreat than advance it can be inserted here.
- **Entry width** - if no pillars are drawn in the perimeter the default is 20 feet. Otherwise, it is picked up from the pillar layout.
- **Panel Attributes** - can be anything the user wants to use such as; ash, sulfur, btu, etc. The user can use fixed values for these or refer to a grid.
- **Prompt for Retreat Options check box** - if this is checked it indicates the shape of the retreat perimeter differs from the advance perimeter. If checked, a separate set of prompts will appear giving the user the option to specify the shape of the retreat perimeter and extraction ratios for the pillars mined inside and outside the advance perimeter.
- **Advance Difficulty Factor** - the difficulty factor used on the advance can differ from that used on the retreat. Normal difficulty is (1), greater than one reduces productivity, less than one speeds up production. The difficulty factor can be a factor or a grid.
- **Retreat Difficulty Factor** - can be specified separate from the advance rate.
- **Equipment Name** - is selected from the defined equipment list.
- **Advance Extraction Ratio** - the extraction ratio is the sum of the area of the pillars divided by the area of the perimeter. This factor is usually 1.0 for longwall panels, but for continuous miner sections is usually near .50.
- **Retreat Extraction Ratio** - this factor is percentage of the remaining pillars left on the advance. This factor can be up to 100 percent for the remaining pillars, as opposed to a number less than 1 minus the advance extraction ratio.
- **Advance/Retreat radio button** - if the user left clicks in the panel after it has been assigned on the advance to schedule it the radio button will gray out the advance button highlighting retreat button.
- **Portion to mine** - options include:
  - **Whole Perimeter** - to mine the entire perimeter.
  - **Distance** - the distance displayed in the box to the left of the radio button is the distance to the spot where the user left clicked in the perimeter to Pick & Place the panel. This is useful if the user want to know the distance to a point inside the panel. When this option is selected, a pinpoint is placed at the distance selected, allowing the user to schedule other panels.
  - **Moving time (shifts)** - the move time in shifts the panel is delayed prior to starting.
  - **Test** - this option lets the user try the settings and get feedback before applying them.
  - **Report Options** - this button gives the user two reporting options, one for an abbreviated timing report and the other for the full report.
  - **OK** - applies the selection and schedules the panel showing the timing.
  - **Cancel** - breaks out of the procedure and returns the user to the command prompt.

**Auto Place Panel by Text**
The Auto Place Panel by Text command gives the user the ability to place panels by drawing text in the panel perimeters on the PANELNM layer. The requirement for drawing the perimeter in the PERIM layer is the same. The prompts are set out below.

**Command:** `auto_place`

**Assign zero retreat extraction (Yes/<No>)?**

**Advance difficulty <1.0> :**
Panel Attributes
The default panel attributes option lets the user assign attributes by value or grid. Certain key or reserved words are available to the user that Carlson recognizes. Choose the Keywords Help button to see them:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>THICKNESS</td>
<td>08\SURVCADD_TIMING-DATA\GRID File</td>
</tr>
<tr>
<td>DENSITY</td>
<td>88.00 File</td>
</tr>
<tr>
<td>ASH</td>
<td>FILEC:\2014\SurvCadd\Timing\date\GRID File</td>
</tr>
<tr>
<td>SU</td>
<td>FILEC:\GRIDS\2006\ycomb_sull_09666 .g file</td>
</tr>
<tr>
<td>ETU</td>
<td>FILEC:\2004\SurvCadd\Timing\date\GRID File</td>
</tr>
<tr>
<td>YD</td>
<td>FILEC:\2004\SurvCadd\Timing\date\GRID File</td>
</tr>
<tr>
<td>ROCKTHICK</td>
<td>08\SURVCADD_TIMING-DATA\GRID File</td>
</tr>
<tr>
<td>ROCKDENS</td>
<td>150.00 File</td>
</tr>
<tr>
<td>DS</td>
<td>FILEC:\2003\SurvCadd\Timing\date\GRID File</td>
</tr>
<tr>
<td>BOTTOM</td>
<td>08\SURVCADD_TIMING-DATA\GRID File</td>
</tr>
<tr>
<td>NUM_LEFT</td>
<td>2.00 File</td>
</tr>
<tr>
<td>ANGLE LEFT</td>
<td>0.00 File</td>
</tr>
</tbody>
</table>
**Define Equipment**

Define Equipment is where the user adds and edits the production rate of the equipment, it can be accessed from Underground Project Manager. Production rates are input for the entire spread or section. This rate can be modified as a function of time, mining height, or strip bench. The Rate/Shift, Hours/Shift, and Rate/Hour back-calculate, allowing the user the ability to fine-tune the production rate. If the toggle to "Define Crews and Units" is on it gives user an ability to define Labor Crews and Units (combination of Crew and Equipment) separately.
The user can specify the minimum and maximum mining heights. Where mining occurs below the minimum mining height out of seam dilution is added to make up the desired minimum height. When the maximum mining height is selected key strata is combined with non-key material where the key strata exceeds the maximum mining height. A cost per hour can be input and it will be multiplied by the hours worked. Maintenance frequency is scheduled in the same units as the Rate/Shift. The delays apply to the entire spread or section in shifts for both Routine and Main Maintenance Frequencies. The recovery factor is designed to be used with elliptical cross-sectioned entries developed with boring machines.

Calendar
The Editing Calendar is a quick and simple way to schedule a production Equipment or Unit (group of a Equipment and Labor Crew working on it). This should be thought of as an equipment, as opposed to a crew scheduling technique. Equipment needs to be added before the calendar is applied. The calendar can be applied to a single unit or all of the equipment. To apply the calendar to several units select the calendar and the unit and Apply the calendar to the unit. Once the calendar is created two different reports can be generated. The first report is the annual unit calendar and the second is a yearly report of what is working and when.
Pin Points
Pin points are break points set in a panel to indicate where the mining temporarily stops to facilitate mining in other areas. When mining resumes in the panel with the pin point it resumes at the pin point. Pin points allow the user to layout fewer panels.

Underground Timing
The Underground Timing option is selected after the panels have been placed, and the equipment and calendar have been defined. Panels are assigned to equipment in the sequence to be mined. Panels can be selected by name from the unassigned list or screen picked. The unassigned panel list can be sorted by name or direction of mining. Delays can be scheduled between panels in days or shifts. The starting date and number of shifts per day are assigned in the designated boxes. Once the run is set up, left click on the Calculate button. Two reporting options are then available. An abbreviated timing report can be viewed or the detailed timing report can be formatted. The user has a wide range of timing options that impact the presentation of the timing map.
Once the report options are selected the map is timed out.
When the report times the map it also develops a report. The report formatter allows the user to customize the report. By moving available variables across to the used variables side in the order from top to bottom the user can set the order in the report. This order also drives the sub-totaling option to create various report styles. The report can be displayed on the screen, printed, made part of the drawing, or exported to Excel or Access. The order set up in the report format from top to bottom is the order in the report from left to right. There is a line editor in the screen display that allows the user to add lines and edit the report prior to printing.

This is an example of exporting the report to a spreadsheet. Totals can be exported to spreadsheets as an option. If totals are exported they show up in bold font. This report can also be imported into the Microsoft Access database for additional reporting options.
Case Study #8, Part 1: Underground Mine Mapping Procedure

Application

Underground mine mapping requires the entry of traverse notes (for the placement of spads), entry of left and right offsets for locating mine pillars and perimeters, connecting the pillars and perimeters, the placing of special mine symbols and strata thickness measurements, and the drafting of projections for future mining. These are all fully covered in the Mining Module of Carlson. The mapping utilities apply primarily to underground coal mines but also to underground limestone, trona and even salt mines. In fact, any mine that creates pillars for roof support.

Procedure

Here's a quick summary of the mine mapping procedure:

1. Enter the traverse notes and plot the spad points.
2. Draw projections.
3. Enter the mine "offset" notes to pillars and perimeter points.
4. Connect up your pillars and perimeters.
5. Add special mine symbols (stoppings, air flow pointers, etc.).

Let's now look at each of these steps in detail.
(1) Entering the Traverse Notes
The most direct method of entering traverse notes begins with Draw/Locate Point in the Points Dropdown and
continues with Locate by Bearing or Locate by Azimuth. You would Enter coordinates or Pick a Point within
Draw/Locate Point. You might choose to enter a specific northing of 1200465.107 and easting of 795091.135. If
this is your first point on the job you will be asked to select an existing or make a new .CRD file (coordinate file).
You would select New and choose a name, typically equal to the name of the drawing. We will call our file MINE.
Then if you select LOCATE BY AZIMUTH under Notes dropdown menu, the program will start at your first point
by default, and allow you to enter an azimuth and distance to the next point, such as 100.1535 (100 degrees 15
minutes 35 seconds), and a distance of 120.09 feet. Press Enter for 0.00 vertical angle and Enter for no Description.
Pressing ENTER will repeat the LOCATE BY AZIMUTH command. Next try defaulting (repeating) the azimuth
by pressing ENTER, and input a distance of 60.05. You obtain a drawing as shown above.

Now, let's enter an elevation for all 3 points. Go to Points, Coordinate File Utilities, Edit-Assign Point. The
following dialog box appears. Enter in the elevation for Point 1, choose next for points 2 and 3. Point 1 elevation is
1016.73, Point 2 is 1016.75 and Point 3 is set to 1017.03.

To enter the additional points. Use the Inverse and Traverse commands from the COGO module in the COGO
dropdown. Make sure Instrument Rod and Height Prompting is turned on Under Point Defaults. This will prompt for the height each time. Go to the COGO menu and turn on Linework. This will draw the lines of the traverse. Now Select Inverse from the COGO menu, or type I at the command line. Here are the next four Traverse point entry values.

**Command:** i, I
**Calculate Bearing & Distance from starting point? Traverse/SideShot/Options/Arc/Pick point or point number: 2**

<table>
<thead>
<tr>
<th>PointNo</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1200443.7177</td>
<td>795209.3048</td>
<td>1016.7500</td>
<td></td>
</tr>
</tbody>
</table>

Traverse/SideShot/Options/Arc/Pick point or point number: T
Traverse, Line OFF, RAW FILE OFF
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <7>: 5 for Azimuth
Enter Azimuth (ddd.mmss) <280.1535>: 280.1535
Points/<Distance>: 60.03
Vertical Angle Type (0-3) <2>: 1 (0=None, 1=Vertical(0d level), 2=Zenith(90d level), 3=Elevation Difference)
Enter Vertical Angle (dd.mmss) <0.0000>: 54
Instrument Height <-2.7000>: -2.7 Use negatives to come down from the roof.
Rod-Target Height <-1.9000>: -1.9
Hz Distance> 60.0226
Enter Point Description <>: press Enter for none
Enter Point Number <4>: press Enter to default to the next available number
N: 1200454.4084 E: 795150.2420 Z: 1016.8929
(next point)

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter
Enter Azimuth (ddd.mmss) <280.1535>: 10.135
Points/<Distance>: 59.98
Enter Vertical Angle (dd.mmss) <0.0000>: -425
Instrument Height <-2.7000>: -2.3
Rod-Target Height <-1.9000>: -2.1
Hz Distance> 59.9753
Enter Point Description <>: press Enter for none
Enter Point Number <5>: press Enter
N: 1200513.4302 E: 795160.8942 Z: 1015.9456
(next point)

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter
Enter Azimuth (ddd.mmss) <10.135>: 280.1535
Points/<Distance>: 60.02
Enter Vertical Angle (dd.mmss) <0.0000>: .23
Instrument Height <-2.3000>: -1.95
Rod-Target Height <-2.1000>: -2.14
Hz Distance> 60.0187
Enter Point Description <>: press Enter for none
Enter Point Number <6>: n
N: 1200524.1201 E: 795101.8352 Z: 1016.5372
(next point)

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter
Enter Azimuth (ddd.mmss) <10.135>: 190.1535
Points/<Distance>: 60.01
Enter Vertical Angle (dd.mmss) <0.0000>: .07
Instrument Height <-1.9500>: -1.78
Rod-Target Height <-2.1400>: -1.85
The following image should appear in the drawing.

(2) Drawing Projections

There are four types of projections: Basic Projections, Advanced Projections, Projections and Ventilation and Rooms. Basic Projections will only produce rectangular projections (not angular). This option, however, has fewer prompts and is more automatic. Let's run Basic Projections.

Start pt. of belt entry: Pick point 4 (You are automatically placed in intersect and node snap mode. All Carlson points have nodes, so you can use the node snap. You can override the pre-set snap by picking the asterisks at the top of the sidebar menu and selecting another choice.)

Command: panel1, PANEL1
Command: (intersect/node on)
Start pt. of belt entry: Pick Point 4 (for point number 4)
<P>ick End Point For Belt or [A] For Azi/Dist: A
Azimuth to end of belt [ddd.mmss]: 10.1535
Distance to end: 540
Number of entries on left side: 1
Number on right side: 2
Entry spacing: 60
Crosscut spacing: 60
Plot Outer Rib Line y/<n>: Y
Cut Width <20>: press Enter
Offset to starting rib line (e.g. -10,0,<10>): press Enter
Offset to ending rib line (e.g. -10,0,<10>): press Enter
Offset xcuts y/<n>: N
Pick pt. on xcut for beginning of stopping line: *pick a point as shown on figure*
Draw another stopping line *<y>/n: Y* 
Pick pt. on xcut for beginning of stopping line: *pick a point as shown on figure*
Draw another stopping line *<y>/n: Y* 
Pick pt. on xcut for beginning of stopping line: *pick a point as shown on figure*
Draw another stopping line *<y>/n: N* 
Pick pt. on entry to begin drawing ventilation arrows [nea on]: *pick a point as shown on figure*
Distance between ventilation arrows: *pick a point as shown on figure*
*<I>ntake or [R]eturn: I*
Draw ventilation arrows on another entry *<y>/n: Y* 
Pick pt. on entry to begin drawing ventilation arrows [nea on]: *pick a point as shown on figure*
Distance between ventilation arrows: *pick a point as shown on figure*
*<I>ntake or [R]eturn: R*
Draw ventilation arrows on another entry *<y>/n: N* 
Project another panel *<y>/n: N* 
You will notice how all projection lines are on distinct layers (PROJECTIONS, PROJSTOPPINGS, PROJVENTARROWS).

With the projection shown, it is easy to illustrate rooms. Select Rooms under the Works dropdown.

**Command:** rooms, ROOMS
Start pt. of rooms: _int of
End pt. of rooms: _endp of
Distance between room entries: 40
Distance between room crosscuts: 40
Room depth: 240
Rooms on <R>ight or [L]eft side: R

While here, let's select Label Proj. Distances.

**Command:** LDIST
**Belt entry (point to point mode)** y/\(<n>/n>: N
**Select line to label distance on:**

Pick as many entry and crosscut lines as desired. This Label Proj. Distances routine applies to Basic Projections and Rooms using the pick line option. The pick option places the distance on the picked line segment. For Advanced Projections, most lines are continuous from the start to the end of the projections, so the point-to-point end-point pick mode must be used. This point-to-point mode must also be used on the belt line (from spad 4), since it is one continuous line.

Now let's label our panel and rooms. Select Panel Label Block.

**Command:** labelplan, LABELPAN
**Insertion point:** Pick anywhere in the open areas.
**Rotation angle:** Pick the rotation angle from the insertion point.

**SECOND DIMENSION** <60'**: press Enter
**FIRST DIMENSION** <60'**: press Enter

Now Select the command: Room Label Block

**Command:** labelrms, LABELRMS
**Insertion point:** Pick an open spot for the center of the label.
**Rotation angle:** Pick the rotation angle from the insertion point.

**ON ADVANCE OR RETREAT** <ADVANCE>: press Enter
**SECOND DIMENSION** <40'**: press Enter
**FIRST DIMENSION** <40'**: press Enter

The final projection option we'll run is Advanced Projections. Select it.

**Command:** panel2, PANEL2 (Intersect/node on)
**Pick Start Point For Belt:** Pick where Pick3 is on the figure below.
**Pick End Point For Belt, or <A> For Azi/Dist:** A
**Enter Azimuth in ddd.mmss** <280.1535>: 280.1535
**Enter Distance:** 360
**How Many Entries Left Of The Belt** <0>: 2
**How Many Entries Right Of The Belt** <0>: 3
Enter Offset For This Heading <0>: press Enter
Enter Offset For This Heading <0>: press Enter
Enter Offset For This Heading <0>: press Enter
Enter Offset For This Heading <0>: press Enter
Enter Offset For This Heading <0>: 20
Use sidebar to select double-dash stoppings.
Pick pt. on xcut for beginning of stopping line: Pick as many xcuts as you would like.
Draw another stopping line <y>/n: Y Use sidebar to select double-dash stoppings.
Pick pt. on xcut for beginning of stopping line:
Draw another stopping line <y>/n: Y Use sidebar to select double-dash stoppings.
Pick pt. on xcut for beginning of stopping line:
Draw another stopping line <y>/n: N
Pick pt. on entry to begin drawing ventilation arrows [nea on]: Pick ventilation arrow location.
Distance between ventilation arrows: Pick interval distance.
<1>ntake or [Return]: I
Draw ventilation arrows on another entry <y>/n: Y
Pick pt. on entry to begin drawing ventilation arrows [nea on]: Pick ventilation arrow location
Distance between ventilation arrows: Pick interval distance
<1>ntake or [R]eturn: R
Draw ventilation arrows on another entry <y>/n: N
Complete the stopping and ventilation options as desired. A plot similar to the one above is obtained. All entries are continuous lines, while crosscuts are individual lines.

(3) Entering the Offset Notes
Since mining operations have different methods for note taking and posting, there are three distinct routines for entering offset notes: Mine Note Left/Right/Face, Mine Note Auto Left/Right, and Mine Note From CRD File. Each of these routines operate with a similar procedure of first choosing a starting point and direction, and then distancing up and offsetting left and right repeatedly. There are also two setup routines. Mine Note From Face Prompt allows the mine note entry routines to post back from the face, and ASCII File From Notes is an option for keeping a record of the offset notes in an ASCII file. All these routines are located in the Notes dropdown menu.

Before we can begin an example, there needs to be some starting points. Select Locate Point and place one point. Then select Locate By Azimuth and place a point at azimuth 100.0000 and distance 60. Repeat Locate By Azimuth with the same values from the second point.

Now we can enter offset notes. Go to Mine Note Auto Left/Right in the Notes dropdown menu.

**Command:** note2

**Enter Offset File Name <offset.dat>:** press Enter

**Append File [<Yes>/No]?** N (This appears only if the file already exists.)

**Tabular Format–Distance L R Hgt– (<y>/n):** Y

**From Station point[(node on):** (795704.0 1.20119e+006) Pick Point 1

**To Station point (A for Azimuth):** A

**Azimuth of Heading (DD.MMSS) or p for pick <0.0>:** 10

**Spad Number, or <ENTER> For None:** press Enter

**Entry Number:** press Enter

**Enter distance from station on centerline (U To Undo, Enter to end):** 10

**Enter left offset distance:** 10

**Enter right offset distance:** press Enter

**Enter distance from station on centerline (U To Undo, Enter to end):** 30

**Enter left offset distance:** C11

**Enter right offset distance:** C10

**Enter distance from station on centerline (U To Undo, Enter to end):** 70

**Enter left offset distance:** 10

**Enter right offset distance:** 9
Enter distance from station on centerline (U To Undo, Enter to end): 88
Enter left offset distance: C10
Enter right offset distance: C10
Enter distance from station on centerline (U To Undo, Enter to end): 110
Enter left offset distance: 10
Enter right offset distance: 9

Enter distance from station on centerline (U To Undo, Enter to end): press Enter

Another Spad [<Yes>/No]? Y
From Station point[node on]: (795763.0 1.20118e+006) pick Point 2
Azimuth of Heading (DD.MMSS) or p for pick <10.0>: press Enter
Spad Number, or <ENTER> For None: press Enter
Entry Number: press Enter

Enter distance from station on centerline (U To Undo, Enter to end): 30
Enter left offset distance: C11
Enter right offset distance: C11
Enter distance from station on centerline (U To Undo, Enter to end): 65
Enter left offset distance: press Enter
Enter right offset distance: 8
Enter distance from station on centerline (U To Undo, Enter to end): 70
Enter left offset distance: 10
Enter right offset distance: 12
Enter distance from station on centerline (U To Undo, Enter to end): 90
Enter left offset distance: C10
Enter right offset distance: C10
Enter distance from station on centerline (U To Undo, Enter to end): press Enter

Another Spad [<Yes>/No]? press Enter
From Station point[node on]: (795822.0 1.20117e+006) pick Point 3
Azimuth of Heading (DD.MMSS) or p for pick <10.0>: press Enter
Spad Number, or <ENTER> For None: press Enter
Entry Number: press Enter

Enter distance from station on centerline (U To Undo, Enter to end): 10
Enter left offset distance: press Enter
Enter right offset distance: 10
Enter distance from station on centerline (U To Undo, Enter to end): 30
Enter left offset distance: C10
Enter right offset distance: C10
Enter distance from station on centerline (U To Undo, Enter to end): 68
Enter left offset distance: press Enter
Enter right offset distance: 9
Enter distance from station on centerline (U To Undo, Enter to end): 70
Enter left offset distance: 10
Enter right offset distance: 20
Enter distance from station on centerline (U To Undo, Enter to end): 88
Enter left offset distance: press Enter
Enter right offset distance: 20
Enter distance from station on centerline (U To Undo, Enter to end): 90
Enter left offset distance: C10
Enter right offset distance: C10
Enter distance from station on centerline (U To Undo, Enter to end): press Enter

Another Spad [<Yes>/No]? N

Print file containing offset input data [<Yes>/No]? N

This should produce the following layout of points and spads:
(4) Connecting Pillars and Perimeter

Once the offset notes have been entered, the pillars and perimeters can be drawn by connecting the dots. Pillars are created as closed polylines in the PILLARS layer, and perimeters are created as closed polylines in the PERIM layer.

There are two approaches for connecting the dots. One is to manually connect the pillars and perimeters by simply picking each point in order and using C to close at the end. This is done with the Draw Pillars and Draw Perimeter routines in the Works dropdown. The other method is to use AutoMine Connections which automatically connects up the pillars and perimeter. This routine reads a record file from a mine note entry routine and requires that the corner points (the first points across a crosscut) are coded. If you entered the example offset notes in the previous section, then everything is ready for AutoMine Connections. Select it from the Works dropdown and choose the file "offset". After drawing the pillars and perimeter, AutoMine leaves a pick box hanging off the perimeter so that you may connect it with a previous perimeter. In our sample case, just enter 'C' to close the perimeter.

It is important for quantity calculations that these polylines are closed. To make sure your pillars and perimeter are closed polylines, use the Highlight Unclosed Polylines routine in the Works dropdown.
Case Study #8, Part 2: Computing Tonnage and Acreage

Application

Once the mine map is completed using the techniques described in the previous section, quantities of mined mineral and waste rock may be computed, with industry standard reports. The reports will be generated based on the reporting method selected in the Mining Settings under Settings, Carlson Configure dropdown menu.

Procedure

Here's a quick summary of the procedure for computing quantities:

1. Configure the "look" of your coal sections (or other mineral).
2. Locate all coal sections measured in the mines.
3. Compute tonnages by average or modeled grid methods.
4. Draw and compute quantities for pillar cuts on the "retreat".

(1) Configuring the Section Information

Configuring the section information involves assigning each strata a name and a density, and specifying the look of the section for when it is placed in the drawing. This information is stored in a user-specified file and is referenced for locating sections in the drawing and for quantity calculations. If you reconfigure an existing section file, sections placed in the drawing using the previous section file become invalid and must be replaced. The strata in a section can be configured as either individual or composite. With the individual configuration, each strata has its own name and density. With composites, each strata is still named separately but they also are divided into groups that have a group name and density. The principle advantage to composites is that it allows you to enter and list out each strata height and then combine the strata into their corresponding composite category when generating tonnage quantities. First, let's configure an individual section. Select Configure Section Info in the Works dropdown.

Enter Coal Section Configuration Filer Name (MINE.SC)

Mine Name: Round Mountain
Enter Abbreviated Strata Name/<ENTER> to End: C This name is drawn next to the corresponding height when a section is located in the drawing.
Enter The Full Strata Name <C>: Coal This name is used in quantity reports.
Enter Abbreviated Strata Name/<ENTER> to End: B
Enter The Full Strata Name <C>: Bone
Enter Abbreviated Strata Name/<ENTER> to End: R
Enter The Full Strata Name <C>: Rock
Enter Abbreviated Strata Name/<ENTER> to End: press Enter

Enter Individual densities or Composite densities (I/C) <I>: press Enter
Average wt. of C (Coal) [lbs/ft^3]: 80
Average wt. of B (Bone) [lbs/ft^3]: 150
Average wt. of R (Rock) [lbs/ft^3]: 150

Circle the Coal Section (y/<n>)? Y This specifies whether a circle is drawn around the section when it is placed in the drawing.

Plot the Numeric Value Only (y/<n>)? press Enter

Text Size <6.0>: press Enter
Enter thickness in feet or inches [Feet/<Inches>]? I for Inches
Prompt for entry width [Yes/<No>]? Y if Yes Linear Advance will also be reported

The following figure shows how this section will appear in the drawing.

Now let's make a composite section. Select Configure Section Info in the Works dropdown.

Enter Coal Section Configuration Filer Name: SECTION2 Or the name of your choice.
Mine Name: Round Mountain
Enter Abbreviated Strata Name/<ENTER> to End: TC
Enter The Full Strata Name <C>: Top Coal
Enter Abbreviated Strata Name/<ENTER> to End: TR
Enter The Full Strata Name <C>: Top Rock
Enter Abbreviated Strata Name/<ENTER> to End: BC
Enter The Full Strata Name <C>: Bottom Coal
Enter Abbreviated Strata Name/<ENTER> to End: BR
Enter The Full Strata Name <C>: Bottom Rock
Enter Abbreviated Strata Name/<ENTER> to End: press Enter
Enter Individual densities or Composite densities (I/C) <I>: C Define the Composite categories.
Enter Composite Category/<Enter> to END: Coal
Average wt. of COAL [lbs/ft^3]: 80
Enter Composite Category/<Enter> to END: Rock
Average wt. of ROCK [lbs/ft^3]: 150
Enter Composite Category/<Enter> to END: press Enter Assign the strata to a Composite category.
Enter Composite Category for Top Coal TC (COAL ROCK ): coal
Enter Composite Category for Top Rock TR (COAL ROCK ): rock
Enter Composite Category for Bottom Coal BC (COAL ROCK ): coal
Enter Composite Category for Bottom Rock TC (COAL ROCK ): rock
Circle the Coal Section (y/n)? press Enter
Plot the Numeric Value Only (y/n)? press Enter
Text Size <6.0>: press Enter
Enter thickness in feet or inches [Feet/<Inches>]? I for Inches
Prompt for entry width [Yes/<No>]? Y if Yes Linear Advance will also be reported

The following figure shows how this section will appear in the drawing.

(2) Locating Sections
To locate section information measured from the mine, select Place Coal Sections from the Works dropdown. Select the desired section configuration file such as SECTION2 which you defined in the previous section.

Pick sample point for coal section: pick a point on the map. This is the point where the measurements came from.
Pick Start Point: pick another point. This is where the text will be plotted. The text may be placed anywhere you like because the program gets the section measurements from the small circle at the sample point and not from the text.
Pick Alignment Point: pick a point to align the text

Now enter your measurements.

How many inches of Top Coal TC: 30
How many inches of Top Rock TR: 5
How many inches of Bottom Coal BC: 25
How many inches of Bottom Rock BR: 4
Enter the entry width: 20
Enter Another Section (Y/N) <Y>: press Enter

Enter the other section as shown in the next figure.

(3) Compute tonnages by average or modeled grid methods
There are three routines for calculating tonnages: Quantities by Average Method, Quantities by Grid Method and Quantities by Centerline. These methods require section sample points, and pillars and a perimeter defined as closed polylines in the PILLARS and PERIM layers respectively. As its name suggests, the average method uses the
average values from sample section points to compute its quantities. The grid method actually models the values of the sample points over the mined area which results in more accurate tonnages. For now, let's use the average method because it is much faster and requires fewer sample points.

Select Quantities by Average Method in the Works dropdown.

Select a Mining Project Definition (MPD) File or Create a new one
Select the file that defines the section sample points
Specify the Beginning and Ending dates of take-up and Report Format in the dialog below

Select property polylines or press Enter for none: press Enter if no property lines defined, if defined program gets Owner Name from here
Fill in the Following Dialog: if any field is left blank it will not be reported

Select pillars, perimeters, and section sample points.
Select objects: select the pillars, perimeter, and sample points
Pick location to draw results or Enter for none: pick a point above the mine as shown
Another Area (Y/N) <Y>: N
A report would be generated based on the Report Format method. If standard method selected following report would be generated

**Update coal tonnage files (<Y>/N)?**  
This option updates data files for tonnage reports.

Enter a mine name: *Mine*

Enter a panel name: *press Enter for none*

Enter the estimated coal reserves for mine Mine: **300000**

(4) **Draw and compute volumes for pillar cuts on retreat**

One of the final steps in underground mining is cutting into the pillars on the "retreat". The results of these cuts can be quickly drawn on the mine map using the Pillar Cut routine in the Works dropdown. The procedure is simply to pick a cut pattern and then place the pattern inside the pillar to be cut. That’s it. Depending on the selected method, this routine will either redraw the pillar's polyline with the cuts removed, or it will create new perimeter polylines inside the pillar in the cut out spaces. The pillars must be closed polylines in the PILLARS layer. The rotation of the placed pattern will follow the current snap. If the cut pattern you need is not already in the table, you can define your own by first drawing a polyline of your pattern and then selecting the user-defined box in the Pillar Cut symbol table.

After redrawing the cut pillars with Pillar Cut, Quantities by Average Method or Quantities by Grid Method can be used to compute the quantities of the cuts. If the Cut option of Pillar Cut was used, then you will get the total

---

**Carlson Software Edit: C:\Documents and Settings\Nimesh Malav\Application Data\Carlson\Model**

**File Edit Settings**

**NUMERICAL AVERAGE COAL SECTION METHOD**

**MINE: Round Mountain**  

**AREA NO. 1 DESCRIPTION: Jones**

**SECTION/UNIT ID: CH-1**  
**MINE TYPE: Advance**  
**MINING METHOD: Shuttle Cars**

**GROSS AREA MINED (S.F.):** 11760.00  
**DEPLETED ACRES:** 0.270

**AREA OF PILLARS (S.F.):** 3217.50  
**ACRES OF PILLARS:** 0.074

**NET AREA MINED (S.F.):** 8542.50  
**NET ACRES MINED:** 0.196

**LINEAR FEET OF ADVANCE:** 427.13

**AVERAGE ENTRY WIDTH:** 20.00

**AVERAGE COAL THICKNESS**  
**INCHES:** 36.00  
**FEET:** 4.67

**AVERAGE ROCK THICKNESS**  
**INCHES:** 11.33  
**FEET:** 0.94

**TOTAL MINING HEIGHT**  
**INCHES:** 67.33  
**FEET:** 5.61

**AVERAGE COAL WT. (LBS/CU. FT.):** 80.00

**AVERAGE ROCK WT. (LBS/CU. FT.):** 150.00

**COAL (TONS):** 1594.60

**ROCK (TONS):** 605.09

**NON-RECOVERABLE COAL (TONS):** 0.00  
**COAL RECOVERY PERCENT:** 100.00%

**TOTAL TONS:** 2199.69  
**PERCENT COAL BY WGT.:** 72.49%

**COAL ACRE-FEET:** 0.915

**CAVITY ACRE-FEET:** 1.100
quantities from the area between the pillars plus the pillar cuts. To get the quantities of only the pillar cuts, use the Perim option of Pillar Cut. This will create perimeter polylines inside the pillars. Then use Quantities by Average Method and select all these perimeter polylines. Let’s practice pillar cuts.

Select Pillar Cut from the Works dropdown.

Choose the Cut 14 symbol or the symbol of your choice.

**Perimeter layer <PERIM>: press enter**

Enter the azimuth for the cuts <0.0>: 10.0

Cut the pillar or create new perimeter? (<Cut>/Perim) Perim

Hatch the new perimeter polylines? (Y/<N>): press Enter

Select mine pillars Polyline in the PILLARS layer.

Select objects: select all the pillars

Pick a point for the symbol: pick a point as shown in the figure above

Do another cut [<Yes>/No]? Y

Pick a point for the symbol: pick a point in the other pillars

Pick a point for the symbol: press Enter to exit

Now let's get the quantity mined from the pillar cuts.

Select Quantities by Average Method in the Mining Works dropdown. Choose Section2 or the file that defines the section sample points.
The Cuts "Selection Type" filters out everything except perimeter polylines and sample points. This allows you to select by windowing the area of the pillar cuts. Be sure not to include the main, outside perimeter.

Select objects: select the perimeter polylines and sample points

Pick location to draw results or Enter for none: pick a point above the mine

Another Area (Y/N) <Y>: N

Update coal tonnage files (<Y>/N)? Y This option updates data files for tonnage reports.

Enter a mine name: Mine

Enter a panel name: press Enter for none

Enter the estimated coal reserves for mine Mine: 300000

This creates the following plot.
Boundary Menu

The Boundary menu has commands for managing pit and property polylines. The property polyline commands are described in the Underground Mining section of the manual.

Name Pit Polylines

This command attaches a pit name and site name to closed polylines that are used as inclusion or exclusion perimeters routines like Surface Mine Reserves and Surface Equipment or Production Timing.

Prompts

Label area names [<Yes>/No]? Choose whether or not to label.
Text height <4.00>: press Enter to accept 4 drawing units (ft or m tall) or enter a new text height
Auto place labels in center [<Yes>/No]? press Enter to accept To manually pick the label position, answer No to this prompt.
Prompt for inclusion, exclusion or both [<Inclusion>/Exclusion/Both]? Bfor Both. If you are only choosing inclusion areas, then you can answer Inclusion to this prompt to skip the exclusion polyline prompt and speed up entry. Or you can use Exclusion if you're just going to add exclusion areas to existing inclusion pit areas.
Site name <Site 1>: press Enter to accept Site 1, or type a new site name
Pit name <Pit 1>: press Enter to accept Pit 1, or type a new pit name
Select Inclusion perimeter polylines.
Select objects: pick closed polylines for areas to include in calculations
Select Exclusion perimeter polylines.
Select objects: pick closed polylines for areas to exclude from calculations
Specify another area [<Yes>/No]? press Enter to accept Yes or type N for no If you do specify another area, then the Site Name remains the same, but the Pit Name is automatically incremented by one for efficient naming.

Pulldown Menu Location: Boundary
Keyboard Command: pitname
Prerequisite: Closed polyline
Assign Pit Names By Layer

When the linework is layerized so that each polyline for pits is placed in the separate layer, this routine may be used to assign pit names by layer name. The user is prompted for site name and pit names are derived from the layer names of each polyline selected.

Prompts

Site name <Site 1>: Enter to accept or type in a new site name
Select polylines to set pit name by layer.
Select objects: pick polylines
Pulldown Menu Location: Boundary in the Advanced Mine Module
Keyboard Command: layerpit

Find Pit

This command will find a certain pit on screen. It will zoom to the pit extents and center it. The pit line is also dashed or highlighted to distinguish it from surrounding pits.

Prompts

Enter a name of the pit to find: x-38
Pulldown Menu Location: Boundary
Keyboard Command: findpit

Label Pit/Site Names

This command labels the pit name and site name that are attached to the selected polyline. The Horizontal and Align placement methods will draw the labels in the center of the polyline. The difference is that the horizontal option will draw the label horizontal to the current twist and the Align method will rotate the label to follow the main direction of the pit. The Pick method prompts you for a center point to pick and an alignment for the text.

Prompts

Text height <4.0>: press Enter to accept 4.0, or type in a new text height
Include Site Name in Label [<Yes>/No]? press Enter for yes or type N for no
Label placement method [<Align>/Horizontal/Pick]? press Enter for Align, or type H for horizontal alignment, or P to pick the alignment and location
Select pit polyline to label: pick a polyline
Site Name: Site 1
Pit Name: Pit 1
Pick point for label: pick a point
Pick alignment point: pick a point
Select pit polyline to label: press Enter to end
Pulldown Menu Location: Boundary in the Advanced Mine Module under Label Pit Polylines
Keyboard Command: pitlabel

Pit Label Formatter

This command places text inside each pit, labeling values such as name, quantities and quality. Anything that is stored in the selected pits will be shown under Available. The formatter screen allows for placement of text in the pits by row, selecting a justification, text size and color. The text can either be drawn horizontally or with the Align
option which will orient the text with the long axis of the pit. There must be values stored in the pits and the pits must have direction assigned.

Move items from the left under Available to the right, under Used. The order you add them is the order they will be labeled in the pits. If they are in the wrong order, use the Move Up or Down buttons. Choose a Text Size that is legible for plotting. The Label Thickness For Missing Strata As Zero is shown here as an option, but applies more to the Drillhole Label Formatter. This format may be Saved and Loaded at a later time with the Load and Save buttons.

When choosing add or Edit, the Edit Text Format screen appears. This is to select the layer and color of the text. The text may have a Prefix or Suffix attached. The Decimals can vary by item. The Row Position is important, so text isn't running on top of other text. Finally, choose a Label Alignment for left, center or right justification.
Prompts

Select pit polylines to label.
Select objects: Specify opposite corner: 192 found
Select objects:
Label placement method [Align]/Horizontal]? H

Pulldown Menu Location: Boundary in the Advanced Mine Module under Label Pit Polylines
Keyboard Command: pitlabel2
Prerequisite: There must be quantities assigned to the pits either from Surface Mine Reserves or Import Timing Data. The pits must have direction assigned to be recognized.

Hatch Pits
This command hatches the selected pit areas. A reason to hatch the pits is to visually check that the whole site is covered by pit polylines. In the options dialog, there are settings for the hatch pattern, color, hatch scale and layer name for the hatches to draw.
Prompts

Select pit polylines to hatch.
Select objects: pick pit polylines
Hatch Settings dialog

Pulldown Menu Location: Boundary
Keyboard Command: pithatch
Prerequisite: Pit polylines

Identify Pit Polylines
This command reports the pit name and site name that are attached to the selected polyline at the command line and shows the pit graphically with a yellow solid fill.

Prompts
Pick inside pit polyline to identify (Enter to end): Pick inside a polyline
If you pick on or near a common line, one pit is highlighted and you are prompted to Press N for next selection or Enter to accept current, highlighted pit line. The selected pit line is filled with a solid yellow hatch that erases when the next pit is selected, or the command is finished.

Site Name: Site 1
Pit Name: Pit 1
Select pit polyline to identify: press Enter to end

Pulldown Menu Location: Boundary in the Advanced Mine Module
Keyboard Command: pitid

Remove Pit Names
This command removes the extended entity data of pit/site names from the selected polylines. For example if you are done calculating for an area, you can use this command to clear the pit names from the polylines in the old area so that these polylines are not picked up as pits anymore by routines such as Surface Mine Reserves and the Timing Routines.

Prompts
Select polylines to remove pit names from.
Select objects: pick the polylines
Removed pit names from 11 polylines.

Pulldown Menu Location: Boundary
Keyboard Command: clearpitnm

Pit by Interior Point
This routine is used to create pit polylines from the existing linework by making closed polylines around points picked. The site and pit names are user-specified and the pit name is incremented after each new pit created. This command uses the Boundary Polyline logic, using any linework (open or closed) and searches out from the picked point for the closed perimeter. It draws a new polyline in the selected layer.

Prompts
Label area names (<Yes>/No)? Choose whether or not to label.
Text height <4.00>: Enter to accept or type new text height
Auto place labels in center (<Yes>/No)?
Site name <Site 1>:
Pit name <Pit 1>:
Layer name <0>: Enter to accept or type in new layer name.
Pick point inside pit perimeter: pick inside a loop or linework representing the pit to use as a pit
Specify another area (<Yes>/No)? If yes is selected, then the Pit Name is automatically incremented by one for efficient entry.

Pulldown Menu Location: Boundary in the Advanced Mine Module
Keyboard Command: pickpit

Pit Plines from Mineplan
This command converts lines and polylines that enclose text into Carlson pits, with the text becoming the pit name. It is best used in conjunction with "Sequential Numbers", a command under the "Draw" pulldown menu that allows the user to place text in increasing order. If pits are to be numbered from U10 through U50, Sequential Numbers
places this text with a single pick. The text inside the pits does not need to be in the same layer as the polylines/lines making up the pits. Since the text is selected by the user, care should be taken not to select extraneous text such as contour elevations.

The user should also avoid selecting contours and other polylines not associated with the pits. It should also be noted that this command makes entirely new polylines in a new layer from the source lines and polylines. If "Boundary Polylines" was used to make closed polylines, and Sequential Numbers is used to place text, then "Pit By Interior Text" will make a new set of polylines in a new layer (this time as "official" pit polylines), resulting in two sets of identical closed polylines. You should use "Delete Layer" or other Carlson tools such as "Freeze Layer" to delete or hide the duplicated polylines. The command will handle arcs. But note that "Pit By Interior Text" will make polylines out of any combination of polylines and lines enclosing text, even where the lines are shared by two adjacent pits and no duplicated lines exist.

"Sequential Numbers" and "Pit By Interior Text" work together to make pits. The location of the text containing the pit name can be used to assign the direction of mining. Therefore, the very location picked within "Sequential Numbers" can set the direction of mining across the pit. If "Assign Directions" is selected within the "Surface Mining" options, the sub-option "Text" will utilize the text insertion position and start the mining through the pit from the side closest to the insertion point. Note that "Sequential Numbers" will middle-justify the text used for the pit name. To emphasize the linkage with "Sequential Numbers", the prompting sequence shown below includes the prompting for "Sequential Numbers".

Using "Pit Plines from Mineplan" you don't need to use "Boundary Polylines" in advance to create the closed pit polylines. "Pit By Interior Text" makes the new polylines and associates the pits all in one step. This command is a great time saver to convert old mine plans with just linework (sometimes sloppy) and the pit name inside to Carlson pits used in reserves and timing.

Prompts

[Sequential Numbers]
Text Height <8.0>: 50
Pick point at center of label: pick insertion point for centered text
Pick point for label alignment: pick text alignment point
Number <1>: U10 (or 50 in the second example)
Auto increment labels (Yes/<No>)? Y
Pick point at center of label: pick next point and U11 (or 51) prints
Pick point at center of label: pick next point and U12 (or 52) print, etc.

[Chapter 16. Surface Mining Module] 2807
Site Name for Pits: Site 1
Layer Name for Pits: PITS
Select pit lines, polylines and text.
Enter snap tolerance <0.0>: This is the size of the gap that the routine can handle to "jump" across and create a closed boundary.
Select objects: select the text and linework New pit lines should appear in the selected layer.

Pulldown Menu Location: Boundary
Keyboard Command: minepitlines
Related Commands: Sequential Numbers, Boundary Polylines, Assign Directions

Pit Matrix Layout

The Pit Matrix Layout function will divide a polyline (preferably closed, but not necessary) into surface pits of any arrangement you specify utilizing temporary alignment polylines. The site and pit names are also defined in this routine. This allows for a great deal of imaginative pit configurations and layouts around difficult geometric and individual situations. The routine will insert the specified number of rows and columns of pits in a matrix form directly inside the baselines, and if used, crosslines. The mine boundary will then serve as an inclusion perimeter and create pits in the matrix form only inside of it.

Prompts

Select mine boundaries:
Select TWO baselines: select objects The best pit configurations result from baselines with equal number of vertices.
Select TWO crosslines or hit Enter for none: select objects Similarly with the baselines, the crosslines should have the same number of vertices.

Note: Baselines are required. Crosslines are not. If just long strips of pits are desired, then just use baselines with no crosslines and enter in 1 for number of pits in the Cutting Across Baselines tab. It is also important to note that the order the base and cross lines are selected will determine where the pit naming will begin. The first baseline selected will be where Pit 1 will start, for example. The same applies to cross lines, for sub pit or block labeling. If there are no crosslines used, then the direction the baselines were drawn will affect the naming of the blocks or sub-pits.
Baselines and crosslines can and probably should be drawn directly on top of the boundary to get exact pit sizing starting at the boundary. They are shown off the boundary line here for clarification of what they should look like. The matrix will begin at the base and cross lines, wherever they are drawn.

With the initial linework completed and knowledge of the general dimensions of the layout, the user can use the following options.

**Number of proportional pits:** This will measure the distance between the baselines and divide the pits proportionally, evenly distributing the size of the pits as they are cut along the baselines using the Number of cuts entry. If the Min/Max options are used, Number of cuts will still be applied. For example, if only 10 pits are desired in a certain layout direction, the routine will stop at 10 pits, then a different plan may be applied from there.

**Min/Max Width pits:** Enter in the minimum and maximum pit widths that will be allowed and the routine will stay within that range to fan pits around corners etc. If the min and max are the same, then all pits will be that width.

**Min/Max/Avg Width Pits:** This is very similar to Min/Max Width, except the average value will be the width that it will use unless it has to fan around a corner. Again, if the minimum and maximum and average are the same, say 175, then all pits will be 175 wide.

The Cross Cut by Advance option in the Cutting Across Baselines Tab should be checked if a certain pit or block size is desired, with little flexibility. Everything is grayed out if this is selected and the block sizing will begin at the cross lines.
Labeling Options: Consider the pit and block scenario. A pit is defined by the base lines and broken into blocks by the cross lines. For labeling, enter a Site Name and Pit Prefix. Both base lines and cross lines can have a section separator (here a dash -). The total number of places can be set with Pad Section and Cross-Section Number so that a resulting pit number such as 056 (for 3 places) can be obtained. The starting pit (section) and block (cross-section) numbers are set in their own windows. The increment is set for both pit and block, here the pit is set to 1 and the block is set to 500. The first few pits in this example will be named: W-056-000, W-056-500, W-057-000 and so on. Distinct Fragmented pits will give a unique name to a pit that is broken due to a gap in the boundary. For example, if the long dragline pit is broken by a washout of coal, and this option is checked, then the pit will have two names: Pit 56a and Pit 56b. It automatically uses a, b, c, etc. If it isn't selected, then both will be named Pit 56.
General: The option to include clipped pits (any pit that touches the boundary) is found under the General tab. An example of both options is shown below. The layer of the new pits is set in the Layer box. The pits are assigned direction for timing with the "Assign direction in which sequence?" option. If you imagine looking down the boundary, from the first selected base line to the second, LL will be mining from the left in each pit, to the right. LR will be from the left in the first pit, then back from the right in the second pit etc. RL and RR are just the opposite.
Labeling options allow special separators.

Including pits clipped by boundary

Excluding pits clipped by boundary

<table>
<thead>
<tr>
<th>Site 1</th>
<th>Site 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pit 026/06</td>
<td>Pit 026/07</td>
</tr>
<tr>
<td>Pit 025/08</td>
<td>Pit 025/07</td>
</tr>
</tbody>
</table>

Labeling options allow special separators.
When geometric layouts for the pits become more complicated, Pit Layout by Matrix will allow the user to design the pits to most any situation presented. It is extremely useful for "fanning" of the pit where corners or varied widths are encountered. This example above shows how a matrix of [10 X 50] can be fit inside a varied boundary such as this angular mine boundary.

**Prompts**

**Select mine boundaries:** select the boundary
**Select objects:** 1 found

**Select TWO baselines:** select the baselines Pay attention to which is selected first for name direction.
**Select objects:** 2 found

**Select TWO crosslines or hit Enter for none:**

**Select objects:**

**Pulldown Menu Location:** Boundary

**Keyboard Command:** cross.pit

**Prerequisite:** The routine requires a polyline boundary for the pits to be designed inside of (better if closed), two baselines, one on each side of the boundary, and optionally, two crosslines to further define the extent of the "sides" of the pits.

**Pit Layout by Advance**

This command creates pits of the desired advance width by intersecting a closed pit polyline and a direction line indicating the direction the pits will be developed. In the first 2 examples below the outcrop has been created as the outer limit of the pit. The first example shows the impact of laying out a straight direction polyline. The direction polyline must enter the pit boundary from outside and exit the boundary to be valid. The program advances along the direction polyline the distance entered for the Cut Advance and intersects for each pit 90 degrees from the direction line. There are two options on where to start the advance. The first is at the end of the direction line and the second is where the direction line intersects the pit boundary. Most of the time the second option is used. The main use for starting the advance at the beginning of the direction line is if all direction lines start at a known...
"station", then all pit blocks will be uniform, named by station and in line with each other.

Example 1 uses a straight directional polyline and was done in 3 sections. Each pit is drawn 90 degrees from it at the desired Cut Advance.

Example 1

Example 2 uses a bent directional polyline to follow the contour of the outcrop. Here it uses a bent polyline to conform to the contour of the outcrop. The direction polyline cannot contain any arcs, however an arc can be initially drawn for the layout and converted to polyline segments using the command Remove Polyline Arcs on the Edit menu. Again, each pit is created by intersecting the direction line at a 90 degree angle. Going around corners will often look better with a smooth line, hugging the inside corner.

Example 2

This third example will go through two iterations of Pit Layout by Advance to first create long strips of pits 175 wide, then break them into blocks that are 500 long, named with the appropriate stationing in the pit name. This is a unique application that is not apparent by just running the command, so a simple case study will follow. Step 1 is to create a mine boundary and draw a direction line through it. Step 2 is the first iteration of Pit Layout by Advance. This example used 175 for the pit width and created long strips of pits with a unique name, such as A-8 and A-9. Step 3 will prepare to break them up into blocks. First, create direction lines through each pit strip. The fastest way to do this is to draw the first direction line through the first strip. Then the ARRAY command will copy that multiple times, placing a direction line down the middle of each pit strip. Running the Pit Layout by Advance will first prompt to select the pit boundaries. Select all of the boundaries at once with a window, fence or by picking. Then it prompts to select the direction lines, select them all at once. In this type of example, the option to start advance at the beginning of the direction lines is chosen. This gives blocks that are named by station along the direction lines. Notice on the south end where the pit strips are not horizontal. Not using the option to calculate from the starting of the advance line will give pit blocks that are offset and not named by station along the direction centerlines. The pit blocks are created and can be labeled with Label Pit Polylines. Notice the pit names and the stationing of the pit blocks incrementing by 500, which is the length of each block.
Prompts

Select all pit polylines.
Select objects: *pick pit polylines*
Select all direction polylines.
Select objects: *pick direction polylines*
Enter Cut Advance: 175
Enter Starting Sub-Pit Number: 1
Enter Sub-Pit Number Increment (1): 1
Calculate the advance from the start of the direction line [Yes/<No>]? *N*
The highlighted pit does not have site and pit names assigned
Enter a site name: *Site 2*
Enter a pit name: *A*
Pulldown Menu Location: Boundary
Keyboard Command: *cutpitadv*
Prerequisite: A direction polyline and a closed pit area polyline.

Pit Layout by Width

This command creates closed polylines that represent pit inclusion areas for Surface Reserves and Timing. The pit polylines are created by advancing a baseline polyline by a fixed pit width. The sides and end of the pit polylines are defined by the minable boundary polyline. This polyline should be open at the end of the baseline polyline.
Be sure to create the baseline polyline longer than the minable boundary so that the program can always find the intersection of the advancing baseline with the minable boundary. There is an option to automatically assign pit and site names to the polylines. The name of the first pit is set in the dialog shown below. The next pits will be named by incrementing the pit name by one. There is an option to prompt for each pit width or use the same width for all the pits.

Prompts

Pit Sizing dialog Set the pit width, layer and names
Select baseline polyline: pick the polyline
Select minable boundary polyline: pick the polyline
Pulldown Menu Location: Boundary
Keyboard Command: pitsz2
Prerequisite: One open polyline boundary and one baseline polyline extending across the boundaries open end.

Pit Layout by Rate

This command creates closed polylines that represent pit inclusion areas for Surface Mine Reserves or the Surface Timing routines. The pit polylines are created by advancing a baseline polyline along a minable boundary. The sides and end of the pit polylines are defined by the minable boundary polyline. This polyline should be open at the end of the baseline polyline. Be sure to create the baseline polyline longer than the minable boundary so that the program can find the intersection of the advancing baseline with the minable boundary. The next pits will be named by incrementing the pit name by one. The baseline polyline is advanced a distance such that the pit volume equals
the target volume.

The surface model is either represented by contours on screen or a grid file. If neither is available, there is an option to Use drillhole surface elevations in surface model. The Ignore zero elevations will ignore anything on screen with no elevation. When modeling from the drillholes, there are 5 modeling methods available, which are defined elsewhere in detail. If a roof and floor grid exist of the strata to target, then use the Grid File option and these two grids will be prompted for. If Triangulation is the selected modeling method, then the options to Use Triangulation Subdivision (defined in Triangulate and Contour) and Use Global Trend Extrapolation (explained in Make Strata Grids) are active. There is the box to create a new layer name for the new pits. If coming from drillholes, there is the option to choose which strata to include. If Selected is checked, then the following Choose Strata box appears. Holding the CTRL or Shift buttons down allow for multiple strata selection. The grid cell size and resolution are set in the Make 3D Grid window, also only if coming from drillholes.

**Pit Layout Parameters**
The cubic yards or meters / hour is set here with the shift hours per day and number of days worked per period. This will calculate the Target Pit Size. In this example, 480,000 CY of OB_TOP strata is the targeted pit size. Turning on the Name Pits box activates the Site and First Pit Name windows. The subsequent pit names will be incremented by one from the starting pit name.
Starting linework
Final pit layout. Notice that the pits get wider to the east as the OB_TOP thins and the pits must be wider to mine 480,000 CY.

**Prompts**

**Pit Sizing dialog**
Select surface entities & at least 3 drillholes
Select objects: select the drillhole symbols and the contour polylines
Select mine boundary polyline: pick the minable boundary
Make Grid dialog Choose a grid resolution.
Use inverse distance to which power (First/Second/Third/Other)? press Enter
Select baseline polyline: pick the baseline polyline
Select minable boundary polyline: pick the minable boundary again

**Pulldown Menu Location:** Boundary in the Advanced Mine Module
**Keyboard Command:** pitsz

**Import Pit Points**
This creates pit polylines using pit names and geometry data stored in a text file. The fields in the text file must be in order of pit name, site name, easting and northing. The fields must be comma delimited. Here’s a sample text file for two pit polylines:

```
PIT 1,SITE 1,243431.6415685746,1646709.1759626027
PIT 1,SITE 1,243480.4441474760,1646852.2833508430
PIT 1,SITE 1,243914.2811566577,1646640.1845039858
PIT 1,SITE 1,243723.9315959779,1646566.2781082289
PIT 2,SITE 1,243480.4441474765,1646852.2833508428
PIT 2,SITE 1,243529.2467263769,1646995.3907390833
PIT 2,SITE 1,243723.9315959779,1646566.2781082289
PIT 2,SITE 1,243914.2811566577,1646640.1845039858
```

**Prompts**

**Input Data File** Select text file to import
**Layer for pits <PITS>:** press Enter
Imported 9 pits.

**Pulldown Menu Location:** Boundary
**Keyboard Command:** importpit2
**Prerequisite:** Text file with pit data

---

**Merge Pits**

This routine takes two adjacent pits or blocks and merges them to create just one. Routines such as Pit Matrix Layout can sometimes leave small irregular shaped pits along complex boundaries. Usually, the user would like to combine or add a small sliver of a pit with an adjacent one so that the volume is reported, but not as its own tiny pit. Pick first in the pit you want to keep, then in the pit you want to remove. A new polyline is drawn around both, representing the new pit with the same name as the first pit you picked inside of. The last step is to simply erase the text of the smaller, deleted pit (if they were labeled). If a pit is selected on or near a line, then the pit is highlighted and you are prompted to hit Enter to accept the pit or press N to highlight the other nearby pit. The volumes are combined if they are stored in the pits as values.

---

**Prompts**

Pick inside 1st pit polyline to merge:
Pick inside 2nd pit polyline to merge:
Created a shrink-wrap polyline successfully.
Done.

If the pick is near a pit line, then the following prompts appear:
Pick inside 1st pit polyline to merge (Enter to end):
Press N for next selection or Enter to accept current:
Pick inside 2nd pit polyline to merge:
Press N for next selection or Enter to accept current:
Created a shrink-wrap polyline successfully.
Done.

Pulldown Menu Location: Boundary
Keyboard Command: mergepit
Prerequisite: Two adjacent Carlson named pits that you want to combine into one pit.

Assign Directions
In order to schedule equipment through pits, pits (which are closed polylines) must have three distinct types of Extended Entity Data (EED, extra information) associated with them. They must have (1) a pit name, (2) NonKey Volume, Key Volume and Key Tons and optionally quality information and (3) direction of mining. The Assign Directions command places the direction of mining into the pit itself, where it is permanently stored along with other aspects of the drawing. Directions can vary by bench. The command prompts to assign the same direction to the Whole pit, or by bench. If doing by bench, the routine must be run separately for each bench.

Assign Directions is found within Boundary in the Carlson Surface Mining. There are six methods employed to assign direction: Automatic, Text, Sequence, Polyline, Bearing and Azimuth. The "automatic" method will mine "longways" across the pit, following the longest axis detected, but may not choose the preferred direction along that axis. The text method finds the side closest to the insertion point of the pit name and will mine from that side perpendicular across the pit away from the text. The sequence method will mine left to right and/or right to left across a series of pits as specified by the user, the polyline method will follow a "direction polyline" across a pit or series of pits and the Bearing or Azimuth method will mine at defined bearing or azimuth angle. Below is the prompting and results obtained with each method:

Prompts

Assign direction using which method [<Auto>/Text/Sequence/Polyline/Bearing/AZimuth]: A or press Enter
Select pit polylines to have direction assigned to:
Select objects: Pick the pits and the direction is assigned as shown below

In this example, the left most pits were given a direction opposite from the remaining pits. For long-term studies or quick estimates using smaller pits, the direction can be considered a moot point, since you will get where you're going to be whether you mined left to right or right to left through an individual pit. But for larger pits or short-term studies, direction is critical. A pit direction can be easily reversed using the Reverse Directions command.

Next we will look at the Text option.

Assign direction using which method [<Auto>/Text/Sequence/Polyline/Bearing/AZimuth]: T
Select pit polylines to have direction assigned to:
Select objects: pick the pits and the required pit text as shown below
The highlighted pit has the direction information assigned already.
Would you like to overwrite this (Yes, None, All): A for All. This prompt only occurs when pits are chosen that already have pit direction. Note that the command "Clear Directions" could be used to remove directions prior to using Assign Directions.

The arrows show the resulting directions. Note that this routine looks for the pit name for the direction, not for the "site" name. (All pits have a two-tiered naming convention: site and pit, which can be re-worked as pit and block or any other two-level form, to adapt to company practices.) In Pit 5, for example, the "Site 1" text is ignored and the "Pit 5" text is used for direction. In Pit 7, the Site 1 text is completely outside the pit, but is irrelevant since only the Pit 7 text is used for direction. If pits were named Pit 1, Block U15A, then the insertion position of "Block U15A" would be used for setting directions.

Next we will look at the Sequence option.

Assign direction using which method [Auto, Text, Sequence, Polyline, Bearing, Azimuth]: S
Select pit polylines to have direction as signed to:
Select objects: select the pits (Don't worry if you also select other polylines. It only finds pits.)
Select a direction polyline.
Select objects: select a polyline that crosses all of the pits This would be the short south to north polyline in our example.
Assign direction in which sequence (LL, LR, RL, RR): LR

In our example, we selected LR, which causes the pits to be mined left to right on the first pit (with respect to the south-to-north direction polyline–imagine yourself standing at the beginning of the polyline looking down it. LL would mine all pits coming from your left. LR would mine from the Left first, then the Right in the next one and so forth. RR and RL are just the opposite.), then right to left on the second pit, then left to right on the third, etc. An entry of LL would cause the pits to be mined from the left side to the right side. An entry of RR, for example, would mine all the pits from right to left. The entry of RL would mine first right to left, then left to right. The sequence method is ideal for assigning direction to a series of long and narrow pits that have not been broken up into small blocks.
If these same pits were each subdivided into 10 or more blocks, or there are many pits that would not be intersected by the sequence polyline, for example, then the following method, direction by polyline, is most appropriate.

Next we will look at the Polyline option.

**Assign direction using which method** [\texttt{<Auto>/Text/Sequence/Polyline/Bearing/AZimuth}]: \texttt{P}

**Select pit polylines to have direction assigned to:**

**Select objects:** select the pits (Don't worry if you also select other polylines. It only finds pits.)

**Select all direction polylines.**

**Select objects:** In the example above, select the single direction polyline.

The polyline-based selection is ideal for contour mines or outer pits in a mountaintop removal situation in Appalachia, or for pits that follow sinuous property lines. Most Midwest and western pit mining is linear, but the polyline technique for setting direction is still applicable. Direction polylines cannot have arcs, so if you've used an arc to draw the polyline, use the command Remove Polyline Arcs on the Edit menu to remove them.

Last we ill look at the Bearing and Azimuth option

**Bearing Option:**

**Assign direction to whole pit or to a specific bench** [\texttt{<Whole>/Bench}]: W or Enter to assign direction to whole pit

**Assign direction using which method** [\texttt{<Auto>/Text/Sequence/Polyline/Bearing/AZimuth}]: B for Bearing

**Select pit polylines to have direction assigned to:**

**Select objects:** select the pits (Don't worry if you also select other polylines. It only finds pits.)

**Enter Bearing (Qdd.mmss):** 145.0000

The highlighted pit has the direction information assigned already.

**Would you like to overwrite this** [\texttt{<No>/Yes/None/All}]: A

The Bearing is entered in the format (Qdd.mmss), the following figure shows the quarter numbers and the angle is calculated clockwise.
Azimuth Option:

Assign direction to whole pit or to a specific bench [<Whole>/Bench]: W or Enter to assign direction to whole pit
Assign direction using which method [<Auto>/Text/Sequence/Polyline/Bearing/AZimuth]: B for Bearing
Select pit polylines to have direction assigned to:
Select objects: select the pits (Don't worry if you also select other polylines. It only finds pits.)
Enter Azimuth (ddd.mmss): 135.0000
The highlighted pit has the direction information assigned already.
Would you like to overwrite this [<No>/Yes/None/All]: A

The Azimuth angle is calculated from the true north.
Pulldown Menu Location: Boundary
Keyboard Command: assign_dir
Related Commands: Display Directions, Reverse Directions, Clear Directions, Create Pit Plines from Mineplan

Display Directions

If directions have been assigned to pits, this command will display the directions. It therefore serves two purposes: (1) to verify that directions have, in fact, been assigned previously, and (2) to review the direction of mining. When pit directions are detected, arrows are displayed as shown below. These direction arrows will disappear with any "Zoom" command such as Pan or Window, and will also disappear if a Redraw or Regen is executed. The direction leaders can be used to draw direction arrow entities in the drawing. The sample drawing is a good demonstration of the use of Assign Direction by Text.

Prompts

Display direction to whole pit or to a specific bench [<Whole>/Bench]: W
Draw directions as leaders or temporary arrows [Leaders/<Arrows>]? L for Leaders or A for Arrows
Select pit polylines to have direction displayed:
Select objects: Pick the pits to review
Pulldown Menu Location: Boundary
Keyboard Command: display_dir
Related Commands: Assign Directions, Reverse Directions, Clear Directions, Create Pit Plines from Mineplan

Reverse Directions
This command reverses the direction of mining within a pit. It is particularly useful in conjunction with the command Assign Directions, <Auto>, since the automatic mode may assign direction to many of the pits opposite from the desired direction. The result is shown below, where the two pit 10s were reversed.

Prompts
Reverse direction to whole pit or to a specific bench [<Whole>/Bench]:
Select pit polylines to have direction reversed:
Select objects:

Clear Directions
This command removes the directions from pits. The Extended Entity Data (EED) designating pit direction is removed from the pit polyline entity. This command has no effect if direction has not been previously assigned to a pit. Keep in mind that it is not necessary to first remove "old" directions before assigning "new" directions. The Assign Direction command will recognize that directions exist and will prompt the user to overwrite the direction for individual pits or for all pits.

Prompts
Clear direction to whole pit or to a specific bench [<Whole>/Bench]:
Select pit polylines to have direction removed:
Select objects: pick the pit polylines This can be done individually or with a window.
Default Pit Attributes

When timing the pits, there are additional attributes that will be calculated and reported in addition to the Non-Key and Key quantities. If these are defaults that should be applied to all the pits, then they should be entered here. It creates a PTA file which may be specified in the Mining Project Manager. Any quality values, density, or difficulty attributes can be defined here either just as a value, or as a grid file with varying values. The Default Pit Attributes window shows what is defined for defaults, the second window, Reserved Attribute Names, displays the reserved words that will be recognized in the timing routines, and how they should be entered in. Selecting Keywords Help brings up the Reserved Attribute Names. Save and Load will create and load the PTA file for future use.

The Reserved Attribute Names are defined in a little more detail here:

- **THICKNESS**: Key strata thickness: Will report any other thickness values, this is used mostly for underground timing.
- **DENSITY**: Key strata density: Will report Key density, is used mostly in underground timing to calculate the tons. In surface timing, the tons are already in the pits.
- **ROCKTHICK**: Non-key strata thickness: Reports the Non-Key thickness mostly for underground timing.
- **ROCKDENS**: Non-key strata density: Reports the Non-Key density mostly for underground timing.
- **TIMEGRID**: User-defined grid to use for timing: This will be any additional grid the user would like to add for reporting.
- **DIFFICULTY**: Difficulty factor on advance just for underground timing: This will alter the underground equipment rate on advance.
- **RET_DIFF**: Difficulty factor on retreat for underground timing: This will alter the underground equipment rate on retreat.
• **DIFF_BENCH**: Difficulty factor for bench * for surface timing: This will speed up or slow down the equipment as it mines the specified bench. If a value is above 1, such as 1.2, then it will mine 20% slower at that point in the grid, or everywhere if it is set to value. If it is less than 1, such as 0.84, then it will mine 16% faster at that point.

• **XXXX_BENCH**: This is the dominate attribute that is most widely used in this command for surface pits. All quality grids will be defined in this fashion, for each bench. The example above, BTU_BENCH1, is defined in this way. All quality parameters need to be entered as the NAME_BENCH*.

**Pulldown Menu Location:** Boundary  
**Keyboard Command:** editpitattr  
**Related Commands:** Edit Pit, Mining Project Manager

---

**Assign Pit Precedence**

This command will automatically reassign the precedence for multi-bench pits. If the pits have been edited or cleared of precedence, this command will restore them to the default setting. Bench 2 will always require that Bench 1 gets mined first. Bench 3 will always require that Bench 2 gets mine first and so forth. This is the default setting that should be there, unless the pits have been edited. This will ensure the benches will not under-mine themselves. This command also detects pit overlap and automatically sets precedence accordingly, if the overlap area is greater than the tolerance area.

**Prompts**

Enter Overlap Area Tolerance (ft^2) <0.0>: Specify the allowed tolerance area
Select pit polylines to process.
Select objects: Specify opposite corner: 3 found
Select objects:
Done.

**Pulldown Menu Location:** Boundary > Pit Timing Quantities  
**Keyboard Command:** pitprec  
**Related Command:** Edit Pit

---

**Clear Pit Precedence**

This command will automatically erase the precedence for multi-bench pits. This is somewhat dangerous, as now Bench 2 can be mined before Bench 1. It is recommended to run Assign Pit Precedence after clearing them, to restore them to the default setting.

**Prompts**

Select pit polylines to process.
Select objects: Specify opposite corner: 6 found
Select objects:
Done.

**Pulldown Menu Location:** Boundary > Pit Timing Quantities  
**Keyboard Command:** clear_pitprec

---

**Clear Pit Bench Quantities**

This command removes all quantity values and grid paths from the selected pits. There is the option to clear all benches at once, or if Specific is selected, then it will prompt to enter a bench number to clear.

**Prompts**
Clear all bench quantities or a specific bench [All/Specific]? A
Select pit polylines to clear.
Select objects: Specify opposite corner: 5 found, 5 total
Select objects:
Cleared 10 bench quantities.

Pulldown Menu Location: Boundary > Pit Timing Quantities
Keyboard Command: clearpit
Related Commands: Edit Pit, Assign Timing Grids, Import Timing Data

**Remove Empty Benches**
This routine looks at all the pits and benches and removes the bench completely from the pit if the volume and/or tons are less than the specified tolerance. This is useful to remove very small quantities that have been stored in pits by mistake, or just from calculations on the edges of the data. Running this command will remove the pit bench with volume below the tolerance, so when running timing routines, the pits won't show up. This is useful for the 3D Pick option in Surface Equipment Timing to remove upper benches that are in the pit, but have no volume assigned.

**Prompts**

Command: emptypit
Key volume tolerance (CY) <0.0>: 100
Non-Key volume tolerance (CY) <0.0>: 100
Key tons tolerance <0.0>: 100
Select pit polylines to remove empty benches.
Select objects: all
7 found
Removed 2 empty benches.

Pulldown Menu Location: Boundary, Pit Timing Quantities
Keyboard Command: emptypit
Prerequisite: Pits with bench quantities assigned

**Assign Pit Attributes**
This command assigns the attributes to the pits that are in the current PTA file defined with the Mining Project Manager. The only reason to do this is if more than one PTA file is being used for different areas of the mine, or the attributes have completely changed, and new ones need to be assigned. These may be verified with the Edit Pit command.

**Prompts**

Enter Bench Number to Assign Qualities To:1
Select pit polylines to have qualities assigned:
Select objects:

Pulldown Menu Location: Boundary > Pit Timing Quantities
Keyboard Command: setpitattr
Related Commands: Default Pit Attributes, Edit Pit
**Reassign Pit Attributes Grids Folder**

This command will reassign the pit attribute grids folders to a new location if they are moved to a new location or computer. It will prompt for the first grid on the list, then reset all to the same location.

![AutoCAD Message](image)

**Prompts**

Select the first grid in the list.

**Drop-Down Menu Location:** Boundary  
**Keyboard Command:** resetpitattr

**Assign Timing Grids**

This command will assign key thickness, non-key thickness and key tonnage grid files to a series of pits or timing blocks. This is an alternate manual way of assigning grids instead of through the Output Thickness Grids option in the Surface Mine Reserves. These grids are associated with a bench number and stored in the pit polylines. This data is used by the Surface Equipment Timing routine, and these three values are required. Optionally attribute quality grids can be assigned here for each bench. You can use the Pit Report or Edit Pit routines to verify which grids are assigned for each bench. The key tonnage grid is tons/square foot or meter. It is easily made with the thickness grid and a density grid in Grid File Utilities. For example: Thickness Grid (feet) x Density (tons/cubic foot) = tons/square ft. The following dialog box allows for interactive entry so all benches can be entered and viewed together as one step. The blue colored text represents required attributes and the black colored text represents optional, user added attributes.

![Assign Timing Grids](image)

**Prompts**

Chapter 16. Surface Mining Module 2830
Assign Timing Grids Dialog Box.
Select pit polylines to assign grids.
Select objects: select polylines with pit/site names

Pulldown Menu Location: Boundary
Keyboard Command: tmgrids
Prerequisite: Key thickness grid, non-key grid, key tons grid, polylines with pit/site names

Reassign Timing Grids Folder
This command reassigns the path of the pit attribute grids stored in the pit perimeters. It is useful when moving the grids folder to a new location, the entire pit attributes do not need to be reassigned, just run this command to point the pit perimeters to the new grid locations. An useful AutoCAD command is XDLIST to view the extended entity data stored within the polyline. This shows the current path of the pit attributes.

Prompts
Select the site/pit perimeter polylines.
Select objects: Specify opposite corner: 10 found
Select objects:
Reset grids for 8 pit perimeters.

Pulldown Menu Location: Boundary > Pit Timing Quantities
Keyboard Command: reset_tmgrids
Related Commands: Default Pit Attributes, Edit Pit

Import Pit Timing Data
This routine imports timing data values into pits from an external text file. The command can bring in the following pre-assigned parameters: Pit Name, Site Name, Key Volume, Key Tons, Non-Key Volume, Difficulty Factor, Start Date and Bench Number, Precedence and other attributes. Also, any user added quality attribute is inserted with the "Add Attribute" button.
The following example is saved as a comma-delimited file (*.csv), which the routine will bring directly in. It imports files with extensions of TXT, CSV, DAT and ASC. Be sure the Site and Pit names are spelled and identified exactly as they appear in the drawing. Shown below is a sample file in Excel. The program will automatically recognize the data that has been exported by the Pit Report command. Changes and additions can be made to the pit report file, and then reimported to attach the data to the pits.

The Formatter Window is very easy to use. Simply dropdown the arrow in the Name row to define what each column is. This will match the data up with the fields in the pits and import the data.

**Pulldown Menu Location:** Boundary, Pit Timing Quantities  
**Keyboard Command:** tmimport  
**Prerequisite:** A pit data file and pits on screen

**Pit Quantities Report**

This command will generate a customized report of all data contained in the pit polylines. It is the compliment of the Import Pit Timing Data command. This command uses the Report Formatter which allows you to customize the report fields layout, and to export the data to a spreadsheet or database. There must be data already assigned to the pit polylines before running this routine.
Prompts

Select the site/pit perimeter polylines.
Select objects: pick the pit polylines
Report Formatter dialog. Choose fields to report then pick Display.

Pulldown Menu Location: Boundary > Pit Report
Keyboard Command: pitreport
Pit Points Report
This command will generate a customized report of the Site Name, Pit Name, Easting, Northing and Elevation of the vertices (corners) of each pit perimeter. This command uses the Report Formatter, so exporting to Excel of Access is seamless.

Prompts
Select the site/pit perimeter polylines.
Select objects: Specify opposite corner: 19 found
Select objects: Report Formatter dialog. Choose fields to report then pick Display.

Pulldown Menu Location: Boundary > Pit Report
Keyboard Command: pitreport2

Edit Pit

Edit Pit allows the user to review and edit the quantities and attributes such as sulfur and BTU stored in each pit. Surface Equipment Timing and Pit Scheduler takes this information and schedules through the pits. This information is placed into pits using commands such as Surface Mine Reserves, Import Timing Data, or Assign Timing Grids. The quantity/quality information in a pit is one of three categories of Extended Entity Data (EED) that can be stored in pits. There is no limit to the amount of data stored here, as it is stored in the Dictionary. The other two are pit name and direction of mining. Edit Pit requires that the user pick inside each pit to review pit data. The pit is shaded yellow for a visual verification of which pit is edited. The command will not proceed if there are not any named, directional pits in the drawing with quantities stored. The program will detect this automatically when the Edit Pit command is selected.

The following values can be edited for a bench: Pit Name, Site Name, OB Volume, Key Volume, Key Tons, Difficulty, Attr. Group, Start Date, Delay, Mineable, Precedence and Attributes. Other values are calculated from these values and pit dimensions. There are two views that can be used to view/edit information about a pit which can be accessed using Tree View and Spread View tabs.

Tree View:
Following dialog shows the tree view for a typical pit. Pit and Site names are shown on the top of the dialog. All benches in the pit are listed in Pit Benches tree view and the information of currently selected bench is shown in Bench Details spread where these can be edited. A separate list box below Pit Benches shows the Precedence for current bench. The Edit and Screen Pick buttons can be used to edit the precedence.
Following dialog shows the spread view for a typical pit. All the benches in selected pit are listed as column headers and associated data are shown below in the spread sheet. Bench precedence is listed in a dropdown list which can be edited using edit button for that bench.

Names and Bench: The Site Name and Pit Name are defined here at the top of the dialog. The Bench Number is displayed. Any of these items may be edited here to save in the pit.

Grids versus Values: There are two methods of storing quantity data in the pits for Surface Equipment Timing. It can either be stored as a value (CY or CM for Volume and Tons or Metric Tons for the Key Tons) or each can be assigned with a grid file. When grids are stored in the pits, the format changes slightly. The OB and Key Volume grids are actually thickness grids of the strata in the bench. The Key Tons grid will be a Tons per Square Foot or Meter. These values or grids are assigned to the pits by 3 methods. The first method is using the Surface Mine Reserves. The option to Store Results in Pits will add the values to the three windows described above. The option to Output Thickness Grids, if checked, will create and store the three grids explained above in the pits. All three grid names will be prompted for at the end of the Surface Mine Reserves routine. This must be performed for each bench needing to be assigned to the pits. The second method to add these quantities to the pits is Import Timing Data. This command will import the Values from a CSV file made with a spreadsheet. These values will be added to the pit as shown in the graphic above, where a value is in all three boxes. The third option, Import Timing Grids, will import the 3 grids mentioned above directly into the pits. All 3 grids will be prompted for. The two Volume grids should be a thickness grid, and the Key Tons grid will be tons/area. This grid can be calculated with the Grid File Utilities (GFU) using thickness and density grids. Now the question arises, why are there two options? Values are used generally for Equipment Timing when the pits or blocks are smaller. Carlson will schedule through the pit at a constant rate until the volume and tons are mined. This is not desired if the pits are very long, or the thickness of the seams varies a lot. That is when the Grid method is preferred. Carlson will schedule through the pit based on the thickness of the grids. If the OB is thinner, it will schedule through the pit faster, and if the OB thickens, the equipment will slow down in that section of the pit. This gives a more accurate representation of the actual mine plan schedule.
Define Pit Attributes versus the Entries in Edit Pit: There is a hierarchy for the use of pit information. In general, like it is for Underground Mining application, the entries in the Default Pit Attributes dialog are surpassed by Pit Attributes specified in Edit Pit routine. However the use of this feature is discouraged since attributes defined this way are stored as a completely separate set of attributes and therefore further changes in the Default Pit Attributes will have no effect on that particular pit. The pit attributes are listed at the end of the Bench Details.

Consider first the qualities. Surface Equipment Timing will honor quality attributes with a name in the form XXXX_BENCH*, where XXXX is a quality name (does not have to be 4 character long) and * is a bench number the quality should be used for. When Carlson runs a calculation for the bench, it evaluates all qualities for that bench and the report puts XXXX part of the attribute name into the report. This way the same quality calculated from different grids for different benches gets reported as a single quality attribute in the report.

Consider next the overburden and key strata quantities. If one or more of these fields are empty then Surface Equipment Timing will try to find pit attributes to use instead. These are defined in Default Pit Attributes also.

ROCKTHICK for OB Volume (C.Y.) as an average non-key thickness value or overburden thickness grid file;
THICKNESS for Key Volume (C.Y.) as an average non-key thickness value or key thickness grid file;
DENSITY for Key Tons as a key strata density or a density grid file.

Following dialog shows the reserved names for attributes, this can be activated using Keyword Help button.
**Difficulty Factor:** The Difficulty Factor will slow down or speed up mining across a pit. A factor of 1.1 means that mining will be slower than the rates set in Define Equipment. A factor of 0.9 means that mining will be faster (precisely 1.0/0.9 or 1.1111 times faster). The difficulty factor used will be 1 if nothing is entered here. If one or two pits present a problem to surface mining (for example, they are near a highway and require time-consuming buffering for environmental reasons), then Edit Pit offers a handy means of applying the higher Difficulty Factor. The user might choose to enter 1.2 or 1.3 directly, to slow those pits down 20 or 30 percent.

If the mining speed is influenced by constantly changing difficulty, the user might resort to sketching out contours to represent the difficulty factor using the command "Digitize Contours". The contours might range from 0.8 to 1.2, in 0.1 intervals. From these contours, a grid file could be generated representing the difficulty. If this grid file is assigned to the attribute DIFF_BENCH* (where * is bench number) within Define Pit Attributes, then this grid value (varying across a given pit) will be applied to all mining and will override any value within Edit Pit.

There is a 3-level hierarchy to the Difficulty Factor. In addition to the entry within Edit Pit and the overriding entry within Define Pit Attributes, there is a higher, overarching concept of layerized DIFF_BENCH* text. If text is found within the pit in the layer DIFF_BENCH* (where * is a bench number), then the real number value of this text (e.g. 0.95) will absolutely control the difficulty used in mining across the pit. As an example, if the text "1.2" appears inside a pit, in layer DIFF_BENCH1, then for first bench the value 1.2 will override the 1.0 that appears in Edit Pit and will also override any grid or value associated with the word DIFF_BENCH1 found in Define Pit Attributes.

**Multiple Benches:** Surface Equipment Timing is bench based timing. It will consider either the tons of key strata in determining the pace of mining or it will consider the volume of overburden and interburden to be removed. If, in reality, different equipment will mine different strata, then accurate timing requires that the mine be divided into benches. These benches are displayed here, in Edit Pit with the Next and Previous buttons. Each bench will have its own quantities and tons assigned, as well as any optional attributes. Precedence will be automatically set so as not to under-mine bench 2 before 1. This two-equipment or bench scenario requires that we have two benches with distinct volumes. This result is obtained by appropriate use of Surface Mine Reserves. To choose different strata for each bench, choose "Selected Strata" under "Which strata to include", and then specify which strata go to Bench 1 and which strata to Bench 2. This requires two separate runs of the Surface Mine Reserves command. The first run would specify the strata in Bench 1 and the second run would specify the strata in Bench 2 (no duplicates!). In short, the key to "benching" are the options "Selected" and "Bench #" within the Surface Mine Reserves dialog box. Benches can also be set with either of the other two import routines, Import Timing Data and Assign Timing Grids.

**Precedence:** Note that the concept of "precedence" comes into play here automatically. The lower bench 2 cannot be mined until the upper bench 1 has been mined. This "upper bench" precedence is automatically assigned by the program. The user has the option to enter a precedence for any given pit by selecting Edit beneath Precedence. The precedence can also be set just by choosing Screen Pick and picking inside a pit to be mined before. If there are more than one bench, the more times it is picked, the subsequent benches are also set to precede in mining.
When "Edit Precedence" is selected, the program displays all pits and benches available. The convention is to put the bench number after the pit name, such as B1 and B2. Edit Pit can also be used to control the order of mining. For example, by using the higher bench on the current and next two pits in the forward direction for precedence for the lower bench 2, the effect would be to always keep the upper bench equipment two full pits in advance of lower bench equipment for a staggered approach.

Starting Date: The starting date can be safely left blank within Edit Pit. However, it may be that equipment scheduling may be subject to permit approval, land purchase, legal consideration, new equipment coming on line, all of which may determine a specific date before a pit could be mined at the earliest. If such a condition applies, a pit starting date can be entered for any given pit. If the equipment reaches that pit prior to the starting date, it will stop and wait until the date arrives before proceeding.

Pulldown Menu Location: Boundary in Surface Mining
Keyboard Command: editpit
Related Commands: Surface Mine Reserves, Define Pit Attributes, Mine Project Definition File

Pit Inspector
This command follows the "inspector" theme found throughout Carlson. Any variable or attribute will be displayed within the inspector window as the cursor is moved from pit to pit. When each pit's information is being displayed, the pit perimeter is dashed to highlight the pit. If a grid is stored in the pit, then just the grid name path is displayed or labeled, not the value. Picking with the mouse inside a pit will bring up the Edit Pit dialog box where changes may be made if necessary. Options will activate the Pit Inspector window to add or edit the items. Label will allow for labeling the Used items on the screen. The text alignment and height is prompted for at the command line.
Prompts

Options/Label/<Pick To Edit>: L (for label)

Pick starting point for label:
Pick label alignment point:
Text height <50.00>:
Options/Label/<Pick To Edit>: O (brings up the settings window again)
Drop-Down Menu Location: Boundary

Keyboard Command: pitinspect
Files:
Reserves Timing Menu

Reserves/Timing Menu

The Reserves/Timing menu has commands for calculating mining quantities and surface timing. The Mining Project Manager and Surface Mine Reserves commands are described in the Geology section of the manual.

<table>
<thead>
<tr>
<th>Reserves/Timing</th>
<th>Surface</th>
<th>Work</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mining Project Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Mine Reserves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Define Equipment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Equipment Calendar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Attribute by Gnd File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Production Timing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Surface Equipment Timing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View 3D Surface History</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Timing Report</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Timing Project Manager

The Timing Project Manager (Surface Project Manager or Underground Project Manager) applies to both surface and underground mining for file organization and selection. All files and most settings and configurations used in the mine scheduling are found in the manager. Each topic is described below in detail.

Settings
• **Coloring Settings:** These settings are from the Report Options screen from the equipment timing command. Defaults can be set here before running the actual schedule. Explanation of this dialog is found in Underground Timing or Surface Equipment Timing. The screen appears as shown here.

![Report Options Screen](image)

- **Attribute Weighting Settings:** This gives the ability to weight average attributes by other attributes, both calculated and internal. Add new lines with the + button. Enter in the Attribute, or pick it from the Keyword Help button. Then dropdown the Weight By Attribute. This will show up in the Report Formatter once the schedule is ran.

![Edit Attribute Weighting Factor](image)

• **Mining Precedence Rules:** This allows for automatic precedence using an user-defined sequence. When using commands such as AutoPlace Panel by Text, it does not set precedence. Using this command makes sure panels do not start before they are exposed or available to be mined. Each rule is shown at the top. Start by choosing the Select button and select two entries that are compared. Then choose which one goes first, if
it is wrong, use the Swap button. Give it a name (optional) and hit Apply. The Preview button will show the order in the lower window.

To use this precedence, turn on the Use Precedence option in the Sequence Window, as seen here and the blocks and panels will reorganize to fit the order.

- **Drawing Event Types:** Drawing events are entities in the drawing at a specific location that will be used for a marker in the schedule as an option for a delay. This event can be used to delay equipment, switch crews, move other equipment, etc. When the schedule crosses over the insertion point of the drawing event (usually text) the event will trigger the delay or effect. The text/drawing entity in the drawing should be inserted to the position where the delay where occur and in the AutoCAD layer defined in the Capture Layer window. The Event Key and description can be used in the reporting of the schedule to create additional reported items.
There are options to set the layer, give it a full description and internal event key name. The Productivity can be set to not working, working (as normal), and not producing (working, but not moving any material). The event delay length is set here by number of shifts. Calendar based will determine if the shift is off in the calendar. If the box is checked, and that shift is off in the calendar already, then it will not take off any more. If it is off, then it will apply to only the next working shift(s) for not working or producing. Additional Units can be used to also set other units off during the same period. For example, if a longwall is down due to a move, then the CM working with it can also be down for the same time. There is also an option to Delay Only Additional Units. This can be used to set one unit down, when a different unit crosses the drawing event. This allows for clever equipment delays and precedence by using different drawing events.

- **Calendar Event Types:** Calendar events are named events that will determine equipment down time. The default event in the calendar is Manual. The other events are set under the Calendar Event Types and Calendar Event Definition. Calendar events can be any event that will cause a delay, such as a routine maintenance, a long wall move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working with crews, using hours, but not mining).
Equipment

• Equipment Set: The productivity of the unit (crew) may vary from shift to shift, up to 4 shifts a day. The number of shifts is set in the Timing window where the sequence of pits or panels is set. The average productivity rate is used for scheduling, however the production rate for the particular pit or panel may be adjusted by setting the difficulty factor or adding delays for that pit or panel. The first window is the edit equipment screen with a columnar display of equipment. Crews can be defined to work with a specific unit, or can switch from unit to unit based on the schedule.

Add and Edit will bring up the next screen for detailed entry.
The Unit of the Production value is defined by a rate unit setting. Equipment may mine either tons, tonnes, CY or CM, Distance and Linear Advance. The difference between distance and linear foot of advance settings is that latter one is a combined length of all pathways/entries mined (underground only), and distance is just distance moved, of a longwall for example.

Enter the Advance Rate/shift or the Advance Rate/hour and the other will be automatically calculated based on the Hours/shift. The Retreat Rate/shift is for Distance and Linear ft of Advance in underground equipment only. The availability value of less than 1.0 will reduce effective production rate of the equipment. 0.94 is a 94% productivity of the full shift.

Underground units may be assigned an Advance minimum and/or maximum height, so that the extra rock will have to be mined or correspondingly unmined coal will be left in the seam if the maximum miner height is less than combined coal and rock parting thicknesses. These settings affect the underground mine timing only.

The maintenance settings provide the ability to schedule a delay for routine or major maintenance/repair of the equipment based on the number of shifts worked. Add in the length of the delay and the number of shifts to determine the frequency.

If operational cost per hour is specified, the total cost will appear in the production report.

The extraction (recovery) factor is used to adjust the amount of material mined form given area to account for certain technical limitations of the equipment such as inability to mine out corners, or not cleaning the top and bottom of ore. This machine will always use that recovery rate.

**Advanced Options:**
Under the Advanced options the variation of equipment-related Difficulty Factor with time, depth or bench number may be specified. Resulting from the advanced options, the difficulty factor is a product of coefficients calculated for given date, thickness and bench number. The final difficulty factor used in calculations is a product of location-specific and equipment-specific difficulty factor.

In the Period End Date column, the difficulty for the date is for next, later date, or last one if no later entry exists. For the thickness column the value of difficulty factor between two entries in the table is a linear approximation. The rehandle value is calculated in the same fashion and passed over to the report, not being used in calculations, but can be used in the report in equations to calculate the total amount mined. The difficulty will modify the rate, and the rehandle is reported. These are not necessarily always the same, linear factors. The Bench Specific Difficulty will be used for surface equipment mining on that bench number, and use that difficulty factor to change the rate of the equipment.

Selecting Edit All from the first screen brings up this editor where all equipment may be viewed and edited. Both the first screen and this one have the import and export buttons.
• New or Existing Calendar: Highlight the Calendar tree, and the New Calendar button is activated if no calendars are present. If some are present, the edit button will also be active for editing a calendar. If it is a new calendar, the Calendar Name box appears to enter a name.

[Diagram of software interface]

The Equipment Calendar allows for entity production down time. By default, entities are working every day, every shift. Entities include equipment, crews, pits and panels. Days and shifts defined in this calendar as down-time are taken into account during scheduling routines. The assignment pattern is very flexible: it works for a particular crew or all crews, for a particular shift or the whole day and allows replication of the defined behavior over period of time as desired. The calendar will clean out, or purge a schedule for a crew which is no longer present.
• **Date Selection**: The calendar should initiate on the current day. Use the left/right arrows to scroll through the months and years. The current or selected day is shown in blue. The shifts appear on the right of each day. There can be up to 4 shifts. If the shift is green, then all entities are working; if it is yellow, then some are working and some are down. If the shifts are black, then all entities are down on that day and shift.

• **Event Rule Definition**: This section is where the event down times are created and edited. Apply adds the event, Reset clears it for the next assignment.

• **Event Entity Filter**: The event list contains the Equipment, Pits or Panels and Crews. The choices for filtering are All Entities, All Equipment, All Crews, All Pits/Panels, Selected (highlight the desired Entity), and Matching (highlight the Entity to find the match).

• **Shifts**: The number of shifts checked here will display next to each day.

• **Due to/Calendar Events**: The options for down time are selected here. The default event is Manual. The other events are set under the Calendar Event Types, activated by clicking the button next to the "Due to" window. Calendar events can be anything that will cause a delay, such as a routine maintenance, a long wall move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working).
• **Repeat for/Label**: This setting is how often the down time will repeat. This can be from a day, month, year or indefinite. This event can have a name, which is entered in the Label window. The calendar will refer to this label when encountering and reporting this event.

• **Events for Date Selected/All Defined Events**: This window displays the events for the highlighted day. If the List All Rules is on, then all the Events will be displayed here, no matter which day is highlighted.

• **Rule Report**: This report displays all of the rules defined for down time within the calendar.

• **Year Report**: This reports all days for the selected calendar year.

• **Unit Report**: This reports all equipment and dates defined in the calendar. See example below.

• **SaveAs/Load**: This saves the calendar, optionally as a new name. Load will open a new one, and give the option to append to the existing, open calendar.

### Timing Assignment
The Timing Assignment allows for setting the current sequence. The Assignment is similar to the TIM file in the timing routines. The equipment used and which panels or pits they are mining are shown. The Set Current button controls which one will be loaded and used. Shown here is both a surface mine and an underground mine example.

Panels
Attribute Groups

Attribute groups are Pit or Panel Attributes assigned to the pits and panels for timing. When timing the pits or panels, there are additional attributes that will be calculated and reported in addition to the Non-Key and Key quantities. If these are defaults that should be applied to all the panels or pits, then they should be entered here. Any quality values, density, or difficulty attributes can be defined here either just as a value, or as a grid file with varying values. The Reserved Attribute Names window displays the reserved words that will be recognized in the timing routines, and how they should be entered in. Selecting Keyword Help brings up the Reserved Attribute Names. If the grid name is red, as shown here, then the file cannot be found. They need to be colored black for successful use.
The Reserved Attribute Names are defined in a little more detail here:
• **THICKNESS**: Key strata thickness: Will report any other thickness values, this is used mostly for underground timing.
• **DENSITY**: Key strata density: Will report Key density, is used mostly in underground timing to calculate the tons. In surface timing, the tons are already in the pits.
• **ROCKTHICK**: Non-key strata thickness: Reports the Non-Key thickness mostly for underground timing.
• **ROCKDENS**: Non-key strata density: Reports the Non-Key density mostly for underground timing.
• **TIMEGRID**: User-defined grid to use for timing: This will be any additional grid the user would like to add for reporting.
• **DIFFICULTY**: Difficulty factor on advance just for underground timing: This will alter the underground equipment rate on advance.
• **RET_DIFF**: Difficulty factor on retreat for underground timing: This will alter the underground equipment rate on retreat.
• **DIFF_BENCH**: Difficulty factor for bench for surface timing: This will speed up or slow down the equipment as it mines the specified bench. If a value is above 1, such as 1.2, then it will mine 20% slower at that point in the grid, or everywhere if it is set to value. If it is less than 1, then it will mine faster at that point. Difficulty is calculated by the equation: \( \text{DIFF} = \frac{100}{(100 - \% \text{reduction})} \).
• **XXX_BENCH**: This is the dominate attribute that is most widely used in this command for surface pits. All quality grids will be defined in this fashion, for each bench. The example above, BTU_BENCH1, is defined in this way. All quality parameters need to be entered as the NAME_BENCH*.
• **SURFACE**: This attribute is used for the 3D Pick window to drape the pit blocks onto the ground surface.
• **SURFACE_BENCH**: This attribute defines the bottom elevation grid for each bench. It is used to display the blocks in the 3D Pick window properly, so the benches are represented accurately.
• **TIMING_SPLIT**: This will globally split all blocks that contain both Key and Non-Key material into two blocks that may be scheduled separately, by either the same unit, or different units. The split is into two portions - key and non-key. Entering a non-zero value will cause a split. Additionally three values are supported as pertains to precedence. Enter in one of these values in for the attribute to split it.
  1 = Both OB and KEY needs to be completed to satisfy precedence
  2 = OB portion needs to be completed to satisfy precedence
  3 = KEY portion needs to be completed to satisfy precedence
• **TIMING_SPLIT_BENCH**: This attribute is the same as TIMING_SPLIT, but is only applied to the specified bench number.

### Reports

Some of the reports generated in the scheduling will appear here for other options to report. These are also accessed in the calendar or after a schedule is run.
Data Links

This shows the link of the data when it is linked to an external source for reporting.

Pull-Down Menu Location: Reserves/Timing in Surface Mining and Underground in Underground Mining
Keyboard Command: stime_project or utime_project
Define Equipment

This command is for inputting and editing the equipment for scheduling routines. It is accessed only in the Timing Project Manager. The productivity of the unit (crew) may vary from shift to shift, up to 4 shifts a day. The number of shifts is set in the Timing window where the sequence of pits or panels is set. The average productivity rate is used for scheduling, however the production rate for the particular pit or panel may be adjusted by setting the difficulty factor or adding delays for that pit or panel. The first window is the edit equipment screen with a columnar display of equipment. Crews can be defined to work with a specific unit, or can switch from unit to unit based on the schedule. Crews are created in the Calendar section of the Timing Project Manager.

Add and Edit will bring up the next screen for detailed entry.
The Unit of the Production value is defined by a rate unit setting. Equipment may mine either tons, tonnes, CY or CM, Distance and Linear Advance. The difference between distance and linear foot of advance settings is that latter one is a combined length of all pathways/entries mined (underground only), and distance is just distance moved, of a longwall for example.

Enter the Advance Rate/shift or the Advance Rate/hour and the other will be automatically calculated based on the Hours/shift. The Retreat Rate/shift is for Distance and Linear ft of Advance in underground equipment only. The availability value of less than 1.0 will reduce effective production rate of the equipment. 0.94 is a 94% productivity of the full shift.

Underground units may be assigned an Advance minimum and/or maximum height, so that the extra rock will have to be mined or correspondingly unmined coal will be left in the seam if the maximum miner height is less than combined coal and rock parting thicknesses. These settings affect the underground mine timing only.

The maintenance settings provide the ability to schedule a delay for routine or major maintenance/repair of the equipment based on the number of shifts worked. Add in the length of the delay and the number of shifts to determine the frequency.

If operational cost per hour is specified, the total cost will appear in the production report.

The extraction (recovery) factor is used to adjust the amount of material mined form given area to account for certain technical limitations of the equipment such as inability to mine out corners, or not cleaning the top and bottom of ore. This machine will always use that recovery rate.

**Advanced Options**
Under the Advanced options the variation of equipment-related Difficulty Factor with time, depth or bench number may be specified. Resulting from the advanced options, the difficulty factor is a product of coefficients calculated for given date, thickness and bench number. The final difficulty factor used in calculations is a product of location-specific and equipment-specific difficulty factor.

In the Period End Date column, the difficulty for the date is for next, later date, or last one if no later entry exists. For the thickness column the value of difficulty factor between two entries in the table is a linear approximation. The rehandle value is calculated in the same fashion and passed over to the report, not being used in calculations, but can be used in the report in equations to calculate the total amount mined. The difficulty will modify the rate, and the rehandle is reported. These are not necessarily always the same, linear factors. The Bench Specific Difficulty will be used for surface equipment mining on that bench number, and use that difficulty factor to change the rate of the equipment.

Selecting Edit All from the first screen brings up this editor where all equipment may be viewed and edited. Both the first screen and this one have the import and export buttons.
Equipment Calendar

Note: Equipment Calendar is also located in the Underground Module section.

This command is accessed through the Surface Production Manager under Reserves/Timing. Highlight the Calendar tree, and the New Calendar button is activated if no calendars are present. If some are present, the edit button will also be active for editing a calendar. If it is a new calendar, the Calendar Name box appears to enter a name.

The Equipment Calendar allows for entity production down time. By default, entities are working every day, every shift. Entities include equipment, crews, pits and panels. Days and shifts defined in this calendar as down-time are taken into account during scheduling routines. The assignment pattern is very flexible: it works for a particular crew or all crews, for a particular shift or the whole day and allows replication of the defined behavior over period of time as desired. The calendar will clean out, or purge a schedule for a crew which is no longer present.
• **Date Selection:** The calendar should initiate on the current day. Use the left/right arrows to scroll through the months and years. The current or selected day is shown in blue. The shifts appear on the right of each day. If the shift is green, then all entities are working; if it is yellow, then some are working and some are down. If the shifts are black, then all entities are down on that day and shift.

• **Event Rule Definition:** This section is where the event down times are created and edited. Apply adds the event, Reset clears it for the next assignment.

• **Event Entity Filter:** The event list contains the Equipment, Pits or Panels and Crews. The choices for filtering are All Entities, All Equipment, All Crews, All Pits/panels, Selected (highlight the desired Entity), and Matching (highlight the Entity to find the match).

• **Shifts:** The number of shifts checked here will display next to each day.

• **Due to/Calendar Events:** The options for down time are selected here. The default event is Manual. The other events are set under the Calendar Event Types, activated by clicking the button next to the "Due to" window. Calendar events can be anything that will cause a delay, such as a routine maintenance, a long wall move, or a dragline dead head. The Productivity Effect allows the option of Not Working at all, Working as normal, or Not Producing (yet still working).
Repeat for/Label: This setting is how often the down time will repeat. This can be from a day, month, year or indefinite. This event can have a name, which is entered in the Label window. The calendar will refer to this label when encountering and reporting this event.

Events for Date Selected/All Defined Events: This window displays the events for the highlighted day. If the List All Rules is on, then all the Events will be displayed here, no matter which day is highlighted.

Rule Report: This report displays all of the rules defined for down time within the calendar.

Year Report: This reports all days for the selected calendar year.

Unit Report: This reports all equipment and dates defined in the calendar. See example below.

SaveAs/Load: This saves the calendar, optionally as a new name. Load will open a new one, and give the option to append to the existing, open calendar.

Pulldown Menu Location: Reserves/Timing in Surface Mining and Underground Menu
Keyboard Command: calendar
Prerequisite: Equipment and crews should be defined for the routine to be used in its full capacity

Set Attribute By Grid File

This command assigns an attribute grid value such as thickness or BTU to a panel or pit area. The program prompts for the attribute name and the grid file that represents the attribute. Then multiple panel/pit perimeter polylines can be selected and the program calculates the average grid value in each panel/pit polyline and stores this value. This command works similar for both surface pits or underground panels. This is the surface pit description.

Another method for using grids is to define the attribute as the actual grid file name instead of the average value. Then the timing routines will calculate attribute values for each timing block from the grid value. The advantage to using Set Attribute by Grid File instead of using the actual grid file is speed. Timing runs a bit slower when reading the grids.

The average value is stored in each pit and can be verified with the Edit Pit command. If the attribute exists there already, it will not overwrite it. Choose the Attributes button and the attribute should be there, as shown in the Edit Pit window. It matches the first BTU value calculated in the example.

Prompts

Type of polylines [Underground/<Surface>]? $S$
Pit bench number <1>: $I$
Attribute Name: $BTU$
Reading cell > 194032
Pass > 1 Null Z values left > 0
Select pit polylines.
Select objects: 3 found, 3 total
Select objects:
Pre-processing grid cells ....
Processing cells ...
Average BTU = 9145.09
Pre-processing grid cells ....
Processing cells ...
Average BTU = 9145.92
Pre-processing grid cells ....
Processing cells ...
Average BTU = 9149.74

Pulldown Menu Location: AdvMine
Surface Production Timing

This command is used for production based timing of a mineplan to see the mine progress when defining production by time period. It is sometimes referred to as a pre-scheduler, prior to running Surface Equipment Timing to get an estimate of mine progression. There are 3 steps needed to prepare for Production Timing as shown in the flow chart below. First, the mining model needs to be set up in the PreCalculated Grids file (PRE). This could also be the geologic model. Next, there must be named, Carlson pit poly-lines representing the mine plan. Finally, the pits lines must have direction assigned for mining. Once these 3 items are created, the command may be run. This command does not use highwall angles or laybacks. It loads the mining model and vertically intersects it with the directioned pits to obtain timing blocks.

Make PreCalculated Grid File ——> Create Named Carlson Pits ——> Assign Directions to Pits ——> Surface Production Timing

The first step is to choose the PreCalc file to process. After it is selected, the first dialog box appears for some initial settings. The Key Strata Recovery can be entered in the window with Set Value, or can be set By Strata Definitions, where it will refer to the Strata Definition File created with the Define Strata command. There, each strata can have it's own recovery. The Key Strata Density is set in the same way. Either by entering it here, or as defined in the SDF file. The units are either pounds/cubic foot or kg/cubic meter, depending on US units or metric units in the drawing. Finally, the Source of Bottom Surface Model can be set here. If Strata Model is chosen, then the routine will use all seams from the surface topography down to the lowest strata grid elevation in the PreCalc file. If Grid File is selected, then volumes will only be calculated from the topography down to that bottom surface grid file, which could be a flat bench elevation for example. A file-select window will appear next, to choose the grid if that option is used.

Next, after selecting the pits and the mining project file, the Surface Production Timing window appears as follows.
The first step is to select pits and move them over to the Assignment box on the left with the Assign button. Following is a detailed description of each item in the dialog box.

- **Do Earlier / Do Later**: These buttons move the pits up or down in the Assignment window.

- **Remove, Remove All**: These buttons will move either the selected pit, or all pits from the Assignment window to the Unassigned Pits window.

- **Assign**: This button will move the highlighted pits from the Unassigned window to the Assignment window.

- **Select All**: This is a quick way to highlight all pits in the Unassigned Pits.

- **Inverse sorting**: If this is checked, then the pits will appear in reverse order in the Unassigned Pits window, otherwise they are in alphabetical and numeric order.

- **Screen Pick**: Allows for manual selection of pits in plan view with a cross-hairs. Simply place the cursor in the pits and pick in the order to mine. Hit enter when done. The selected pits should appear in the Assignment window in the order they were picked.

- **Report pits on one row**: This option is for report formatting. If this is checked, the report will have one row per time period and all strata quantities and qualities will follow on that row, each in their own column. If this is not checked, then each strata will be in its own row in the report, with its quality to follow. This is option is usually not selected.

- **Use property boundaries**: There must be named property boundaries on screen for this option. Production timing will automatically detect them and break out the production by owner and property if desired.

- **Draw timing blocks**: One of the main items of output from this command. It draws the periods as blocks of solid fill or any hatch pattern inside the pits in plan view. They are colored by period. As they are being drawn, the direction and progress of the mineplan can be seen for review.

- **Draw distinct outline**: This is very similar to the timing blocks, except that they are just closed polylines with no fill or hatch. They are in their own color, and optionally, layer. They can be used later for further
**Reserve calculations, or to save the mineplan without hatch or fill.**

- **Draw labels:** This option places the period name in the block or outline. It is either the user defined label, or will just use "Period1", "Period2" etc.

- **Text autosize:** If this is selected, the text will be automatically sized to fit the size of the block outline. Otherwise, the text might be too large for some of the smaller blocks.

- **Draw labels length-wise:** Selecting this option orients the text lengthwise to the long axis of the block outline. Otherwise it will be placed horizontally.

- **Text Size:** Enter in the text size for labels. It will use this if Text Autosize is not selected.

- **Text Style:** Enter the AutoCAD Text Style for labels and legend.

- **Draw Legend:** Select this option to draw a legend of the timing blocks showing the color and the name of the period. It will ask to pick the legend position.

- **Legend Scale:** Enter in a legend scale size to size the legend.

- **Layers by Period:** This option will create a new layer for each time period and draw the blocks and outlines in those layers.

- **Production Table Type:** This is a very important setting that needs to be selected for the target material. There are 10 choices to use for production targeting. Most common are Key Tons and Overburden Volume, but others are available. Total Tons converts all strata to tonnages and mines them accordingly. The NonKey density is set in a window that appears as soon as Run is selected. Key Tons are tons of the combined key material, which name is set in Configure /Mining. Waste Tons will combine all NonKey strata, calculate the tons for it and target that tonnage for production. Mined Area will target a defined area in square feet or meters for production. Total Volume will combine all strata, both Key and NonKey and target the total CY or CM. Key Volume or Coal Volume will target the CY or CM of all Key strata in the selected PreCalc file. Waste Volume combines all NonKey strata and targets the CY or CM of them. User Grid will take any grid and target total quantities for production. An example of this would be a power plant that wants to target total BTU. The grid to select would be total BTU/area. Finally, the Overburden Volume will take just the first NonKey strata in the PreCalc and target that, but still report any additional NonKey seams below it.

- **Stop at Last Period:** If this is checked, then the routine will stop after the last period entered in the Production Table. If it is not checked, then it will continue with the last target amount all the way through the
last selected pit polyline.

- **Production Table:** This is the screen to set the production amount and time period or date. The first column is the amount to target. This is what you have selected under Production Table Type. The second column is the color for that period. The next column is the hatch pattern for the block. If it is a hatch pattern other than SOLID, then it must have a scale factor, set in the next column. The AutoCAD Layer is set in the next column and finally, the Label is set in the last column. This can be anything from dates, to owners and areas. If the Labels are left blank, then it will fill in labels such as Period3, Period4, or month or year, etc. The Clear button will clear the entire screen. There are Save and Load buttons for easy retrieval of the CQT files.

![Define Levels](image)

- **Undo:** This will undo a previous run, removing the colored blocks and outlines.

- **Run:** This is the button to start the actual timing and sequencing of the pits. After the Production Table and all the settings are good, then choose Run.

- **Finish:** After the blocks are drawn and the Surface Production Timing window comes back, selecting the Finish button will start the calculations and generate the quantities and qualities in the Report Formatter. Here items are selected to appear in the report and exported to a file, such as Excel or Access.

A finished map with the blocks drawn on it and the corresponding report are shown here. In this example, the amount was set to 225,000, then 250,000 tons. In the report, notice the accuracy of the tons. Most are within a couple of hundred tons.
Pulldown Menu Location: Surface Mine Module - Reserves/Timing
Keyboard Command: calcplan
Prerequisite: Timing pit polylines

Chapter 16. Surface Mining Module 2867
Pit Scheduler

Pit Scheduler is a short-range surface mine scheduling command and is located under Reserves/Timing dropdown menu in Carlson Surface Mining. It displays selected pits in a cross section view with benches and allows user to assign equipments to pit benches by time period. The planner can simply pick on a bench to mine/un-mine it and the updated quantities will appear in the quantity spreadsheet. These quantities can be reported using report formatter at any time.

Interface Components

1. Menu
   The Pit Scheduler has three main dropdown menus.
   a. File Menu
      i. Read Pit Blocks: This command can be used to read in the new pits in the view to work on.
      ii. Report: This command can be used to report the currently assigned quantities.
iii. Export to Bitmap: This command can be used to save the current pit display in to a bitmap file.
iv. Save and Exit: This command saves all the assignment and exits from the Pit Scheduler.
v. Exit: This will exit from the Pit Scheduler without saving any assignments.

b. View Menu
i. Project Manager: This command brings up the Surface Project Manager that can be used to define equipments, timing calendar, and other components to be used in scheduling and to view assignments and loaded pit names.
ii. Settings: This command shows the settings for Pit View, Pit Text and Mining.

- Pit View: These settings can be used to modify the pit display to view it more efficiently. The "Pit Width" and "Pit Separation" can be set for better viewing the pits based on their thickness. The pit width is the width of the pit column and pit separation is the separation between two pit columns. The "Show Pit" allows users to specify the number of pits to view in the current view. If "Zoom selected Pit in plan view" is on as soon as used clicks on a pit it will be highlighted in the AutoCAD drawing plan view and the view will be zoomed in to the current pit. The "Set Common Elevation" option allows pits to be hanged from a common elevation specified in the "Elevation" edit box, if this option is turned off the program looks for the "SURFACE" attribute for the pit and reads the elevation from there.

- Pit Text: The Pit Text settings can be used to display different text in the pit display for a pit column.

- Mine Settings: These settings are used in timing the pits similar to used in Equipment Timing.

c. Tools Menu

i. Clear Assignments: This command clears all the assignments for the current equipment selected in "Equipment" dropdown list. This will allow user to select the assignments for equipment from the beginning.

ii. Clear All Assignments: This command will clear all the assignments for all the equipments and bring the mine to the starting point, and allows user to start the scheduling from the beginning.

2. View Toolbar
3. Pick Mode and Selection Option
a. Pick Mode: is used to set the mode for selection of pit benches. There are three pick modes:
   i. Assignment: This mode is used to assign the current equipment selected in the "Equipment" dropdown list to the selected bench/benches based on the "Selection Option".
   ii. Waste Bench: This mode is used to specify whether a bench will be mined or treated as waste bench. The waste bench quantities will not be added to the quantities as it will not be mined.
   iii. Add Delay: This mode allows user to add delays associated with a bench. If this mode is selected than based on the selection option delay will be added to the bench/benches and mining will be delayed by delay duration. (Look in Surface Equipment Timing for more information on adding delays)

b. Selection Option: is used to apply the pick mode to the benches. There are five selection options user can choose from.
   i. Individual Pit: the pick mode will be applied to the selected bench in selected pit.
   ii. Current View: the pick mode will be applied to the selected bench for all the pits in the current view.
   iii. All Pits: the pick mode will be applied to the selected bench for all the pits loaded in the Pit Scheduler.
   iv. Pits to the Right: the pick mode will be applied to the selected bench for selected pit and to all the pits on right side.
   v. Pits to the Left: the pick mode will be applied to the selected bench for selected pit and to all the pits on left side.

4. Pit Navigation
The Pit Navigation can be used to scroll through the loaded pits. The "Goto" pit allows user to select the starting pit for the view. The Left or Right View scrolls the view to left or right respectively by the number of pits selected in "Show Pits" in the Settings dialog under View Menu. The Move Left or Right scrolls the view by a single pit.

5. Pit Display
The Pit Display shows the pits with benches in a plan view based on the view and text settings. Following figure shows a typical Pit with all text options turned on.
6. Tool-Tip
A Tool-Tip window is shown with the full name of bench (Site-Pit-Bench) and Key and Non-Key thickness when user cursor over a bench.

SITE 1-PIT 5-B1
Key Thick: 0.5
NonKey Thick: 86.0

7. Period & Equipment
a. Period: can be used to view the number of days used and available for the selected equipment. The Period string can be formatted using the Period Formatter dialog or can directly be typed in the edit box. The Period string must be in the specified format. As soon as the user updates the Period and hit enter the ''Days:'' label is updated to show "Used Days/Available Days (Period Days)".

b. Equipment: This dropdown lists all the defined equipments in the Project Manager. The current selected equipment is used for assignments.

8. Quantity Spread
The quantity spread shows the quantities and qualities for the equipment selected in "Equipment" dropdown for each bench it is assigned to. The spread shows Equipment, Bench, Key-Tons, Key-Thickness, Non-Key Thickness, Key Volume, OB Volume, Area, Acres, and Strip Ratio columns followed by the pit attribute values.
9. Elevation
The current elevation of cursor is show on the "Elevation" label. If the "SURFACE" attribute is defined for the pit it will show the actual elevation for that pit and its benches.

10. Right Click Menu
A Right Click menu pops-up when user right click on a Pit Column. This menu lists Edit Pit followed by the full name of benches in that pit. The thickness of a bench can be very small that it becomes hard to pick that bench using left click, in that case right click menu can be used to pick that particular bench. It shows the mined benches with a check mark. The "Edit Pit" command can be used to edit the pit values and attributes. (For more information refer to "Edit Pit" command under Boundary dropdown menu of Carlson Surface Mining).

Pulldown Menu Location: Reserves/Timing in Surface Mining
Keyboard Command: pit scheduler
Prerequisite: Pits with assigned quantities

Surface Equipment Timing
Surface Equipment Timing schedules through surface pits and blocks based on equipment mining rates in accordance with a calendar. The mining rate is typically based on volume of overburden but may also be based on tons of key strata. The calendar is set by the user to indicate when entire days or individual shifts within a day are down for holidays, time off, or other reasons. The pits themselves must contain key strata and overburden information which is placed in them through use of Surface Reserves, Import Timing Grids, or Assign Timing Data. Surface Equipment Timing is distinct from Surface Production Timing by requiring use of quantities or grids stored in the pits, use of a calendar, and defined rates of production for equipment. The Calendar, Equipment and Crews are defined in the Surface Project Manager.

The Project Manager also appears at the start of Equipment Timing. The purpose of the timing project database file is to provide a single place where everything related to the timing project is stored. This includes equipment definitions, reporting settings, pit and panel information and reports produced. This also includes other data such as calendars, equipment options, date and weight tables, text block definitions. Basically everything except for the grid files, which will be referenced. This means that reviewing or even repeating results of a schedule done previously will be much easier if everything including the last results is stored in the same place.

The left side of the dialog has a tree control which displays the categories of items on the top level, with either set of items or actual items underneath. Depending on what is selected on the left, the buttons on the right will reflect the functionality available for the current selection. The sets of items showing in bold reflect the current set when applicable: i.e. the project can have multiple sets of equipment defined, but the one showing in bold is one used in calculations. By double-clicking on the item the Edit function can be executed if applicable. For equipment, the user can edit, add, copy or remove entire sets of equipment. Use the Set Current button to set a particular item current. Equipment can be imported from an older Equipment Definition file or from another project. It can also be exported to another file. A number of different data can be output to an external data source or brought up in the report formatter.
Following is a detailed description of each function on the Surface Timing window and subsequent windows. After that is a step by step procedure for setting up for the Surface Equipment Timing.

- **Add Unit:** Selecting this button will bring up a list of Available Equipment for selecting a unit to add to the Surface Timing window. This must be done first, before assigning pits or blocks.
• **Edit Unit:** This button will go to the Equipment Production Rate window, similar to Define Equipment. Any rate or shift changes made here will be saved to the equipment file.

• **Replace Unit:** This replaces one unit with another.

• **Remove Unit:** This button will remove the high lighted equipment from the list of Equipment Involved. It will still remain in the fleet for future use, just not on the list for the current mine plan.

• **Edit Calendar:** This will bring up the active calendar where any changes and edits can take place.

• **Do Earlier:** This option will move a selected pit/bench up the list in the Assignment window.

• **Do Later:** This option will move a selected pit/bench down the list in the Assignment window.

• **Remove:** This option will move the selected pit/bench from the Assignment window back to the Unassigned window.

• **Remove All:** This option will move all of the pits/benches from the Assignment window back to the Unassigned window.

• **Add Delay:** This inserts a delay in-between the pit blocks. This brings up the same delay setting as found in the Drawing Events.

• **Assign:** This button will move the high lighted pits/benches from the Unassigned window over to the Assignment window.

• **Select:** This is to select the pits and their appropriate benches for assigning. It will highlight them, ready for the Assign. The choices to select are None, All, or by bench number, such as all the Bench2, or the Bench3.

• **Use Precedence:** This gives the ability to adjust sorting of unassigned pits/panels so that precedence is satisfied (violating names are moved down the list until precedence is satisfied)

• **Screen Pick:** Selecting this allows for screen picking of the pits in plan view. Cross-hairs appear, and the command line states: Pick on or inside of pit polyline or Enter to finish:. Pick inside the pits in the order they should be assigned. Picking once assigns the first available bench. Picking again in the same pit, assigns the next bench (if available) immediately after the first one. Hit Enter to get back to the Surface Timing screen, and the pits should be assigned in the order picked on screen.

• **3D Pick:** This option gives a 3D view of the pits and the quantities stored in them. It allows for viewing, rotating and selecting of the pits to be mined in 3D. When a pit and bench is picked, it disappears from the mine plan, revealing the block beneath it. There must be a Pit Attribute called SURFACE with the surface topography grid assigned to it. Rotate the view to see the benches in 3D, select a unit, and start picking the blocks in the order to be mined. The "mode" it is in will determine what the mouse icon is.
Vertical Scale: This dropdown allows a different vertical scale set in the window from 1X to 16X Single Pick / MultiPick. This allows for switching between selecting one pit block at a time, or a range. To select a single pit block, set the mouse to the arrow/pointer, then double click on a pit block to remove and mine it. If there is a range of pit blocks to select, choose the Multi Pick option and using the same arrow pointer, double click on the starting pit block, and then again on the ending pit block of the line of blocks to mine. Keep picking until the end of the string is reached. It will draw a red line from pick to pick. When finished, Right Click the Mouse, and all the blocks crossed by the red line will mine out in the order they were crossed. This will remove and mine that entire range for scheduling. Use Bench Rules: This option will apply the bench rules to benches on top and those are assigned to the equipment selected for each bench in order top to bottom with defined sequence. The Bench Sequencing screen to set this up is shown below.

Zoom button gives the magnifying glass with the +/- to zoom in and out. Rotate button gives the XY icon to tip it on its side, and the Z icon rotates it around the Z axis. Pan button gives the hand and pans around the screen.

The Pick arrow button is the easiest icon to select the pits with. Just move the icon on top of a block and double click with the left mouse button. The name of the pit and bench it is pointing to is shown above the equipment window. The block will disappear and the name will be added to the Assignment list. Any mistakes can be removed with the Remove Button, the green X.

The Shade button renders the pit benches otherwise they are just 3D faces not shaded. The Zoom Extents button returns to plan view, and zoomed to the extents. Turn Benches On/Off button brings up the Set Layers window where unselecting a specific bench will remove it from the 3D image. Each bench color can be set here for better 3D visualization. These color settings can be saved and loaded at a different time. The Mining Rules sets up the precedence on what must be mined in upper benches to get to the desired block below. Bench Sequencing allows the user to setup default equipment for each bench and bench sequencing rules with ability to play back the sequence with the Play arrow >. A mining sequence rule for the top bench can be setup for each bench by setting the offset in North, East, West and South direction where North begins the twist screen angle from the drawing. Use the Twist Screen command first to rotate the blocks if they are not laid out on a N-S-E-W pattern. Once the rule is setup for one bench it could be applied to all the benches with the Set to All. The Upper Bench Offsets control how many blocks must be removed in each direction from the bench above. The Upper Bench
Sequence sets the order of how to mine these blocks.

Once the bench rules are setup, there is an option to select the Bench to draw the advance on the screen by using "Draw" button, this will draw the perimeter for each bench on top, to show how much needs to advance to uncover the underlying bench for the selected pit. The perimeters will be drawn with the selected color for each bench in CAD.

The Chart Settings button brings up the window for selecting the bar chart attributes to display. Everything stored in the pit benches is available to display in the bar charts. When a pit bench block is selected, the tons, volume or quality of the bar charts increases to show the values. This shows a running total of the values as each block is picked and removed to be mined. The ranges for each attribute set the minimum and maximum values for the bars on the chart. So, as an example if 200,000 tons are needed for some short range mine planning, set the Key Tons to 200,000 maximum and then it is easy to see how many blocks are needed to be picked to get to that volume. Or, if a certain quality of Key material is needed, select blocks and monitor the quality to keep it in the desired zone.
- Timing can be run from this window by selecting the Report button. It brings up the window with the finish date, where the Report or the Detailed Report are selected. Choosing Detailed Report brings up the Report Options and runs the schedule, and hatches the pit blocks in the drawing.

- The blue circle with the yellow square in it is the light control, to cast shadows where the light shines from the direction selected.

- The Vertical Scale box changes the scale for better viewing of sites with low relief.

- Screen Entities button will allow for any picking in CAD of 3D entities to show up in the 3D Pick window. Entities such as contours, ramps, roads, pit shells and perimeters can be selected and viewed with the blocks in the 3D Pick window.

- When done, just hit the Exit button (the door with the arrow going out) and you are back to the main Surface Timing sequencer.

The program uses the SURFACE grid as a starting elevation and the thickness of each block is relative to the volume of material assigned to each bench in the pits. Benches with more volume will show up thicker than others with less. The color scheme is based on the bench you are on. For better viewing of complex pits with separate bench polylines in 3D, surface attribute for each bench can be defined with attribute name SURFACE_BENCH# and value equal to the bench bottom elevation grid. If these attributes are defined the program builds the 3d pick view from top-down calculating the thickness on each pit vertex as elevation difference between two consecutive benches.
• **Add Delay of Days/Shifts:** Adding a number in the day or shift window and hitting the Add Delay button will bring up the following windows. Highlight the pit/bench in the Assignment window and the delay will be added below the row that is highlighted.
The Schedule Effect on Delay gives two choices: Schedule delay, where the delay will take affect when the equipment is working. If the calendar has the equipment off at that time, then the program waits until it starts to work again, then schedules the delay. A Calendar delay, where if the calendar has it off already, then that is all it will do. It will not take it off additionally. The Due To option provides Drawing Event Types to choose from. Choose the button with "..." next to the Due To, to open the Drawing Event Types window. To Add or Edit a type, the Capture/Timing Event Definition screen provides names and productivity options. Any where the text drawn in the Capture Layer is encountered in the drawing, the equipment will be delayed by the Event Delay Length in shifts. The Productivity Effect is the result of the delay. Not working is where the equipment is completely down. Working is no change, and Not Producing is where the equipment is in use, but no quantities are being mined.
• **Assigning Bench Specific Events:** If you want an event to associate with a specific bench put the event on the layer with "BENCH##" (## - Bench Number) suffix to layer name. For example if the dragline move event occurs only on the bench 3 the capture layer name would be "DraglineMove_BENCH3", if there isn't any _BENCH## it would apply to all the benches. Also update the Capture Layer name in the event definitions to "DraglineMove_Bench3". This would make sure that drawing event will occur only on the equipments working on Bench3. You can specify other event on specific benches same way.

• **Undo Report:** This option will Undo a previous Surface Timing run. It will delete the blocks or perimeters drawn in the drawing. If a quick change to the plan or equipment is made, it can be re-run very quickly just by hitting Undo Report and then Calculate again.

• **Starting Date:** This must be filled in before selecting Calculate. Use the format that is defined for dates in Configure under Settings. It can be 12/15/2014 (US) or 15/12/2014 (Australia and Europe) etc.

• **Number of Shifts:** This is the number of shifts the program will use in the actual sequencing. Even if 3 shifts are defined for the equipment or in the calendar, and 2 is entered here; it will only use 2 shifts in the timing. It uses the first two, ignoring the third shift in the equipment rate and calendar.

• **Skip Ore (Key Strata) for Timing:** This toggle will determine if the equipment is mining just the NonKey/Overburden material or both the NonKey and Key Material that appears in the pit and bench. For example, a dragline moving overburden should have this checked so that it ignores the coal volume. It will still report the Key volume and tons, but not use it for the schedule.

• **Perform Bottleneck Analysis / Bottleneck Parameters:** Bottleneck analysis is an option in Surface Equipment Timing that lets you limit the total production from several units to a specific level, even if the sum of the units’ production exceeds the set level. To use this method, check the box for Perform Bottleneck Analysis and then set the parameters.

![Bottleneck Analysis Parameters](image)

The Bottleneck Parameters dialog box is found on the Surface Timing dialog under the Bottleneck Params button. The Field Name you specify must match one of the reserved words for volume, tons, or a user-defined attribute. These reserved names can be found in the Edit User Attributes section in the final report if they are not known. The Threshold value is another name for the limit placed on the attribute name. This limitation can be set for specific equipment units, and it can be set for ALL units as well. To set the unit preference order, ADD them to the dialog box to the right under the Equipment Order heading. The order can be changed by highlighting the unit (by selecting it with the left mouse button) and picking the UP or DOWN button to the right.

There are several schemes you can use to determine which units are restricted to meet to required level.
When production capacity exceeds the system's ability to absorb it, some units need to be scaled back. The options available to reduce production include:

1. **Normal Rotation** - alternates in order through the units.
2. **Hold Lead, rotate rest** - operates the primary unit at full capacity and alternates through the rest of the units reducing production.
3. **Hold tail, rotate rest** - opposite of Hold Lead.
4. **Fixed order** - maintains the order of unit preference reducing production, beginning with the tail unit until it is completely down, then reducing the next in preference order until the objective is met.

Example: There are 4 excavators on a job (Units A-D) with a capacity of 3,000 cyds per shift. All of the material must be loaded in trucks and hauled away. There are 6 trucks in the fleet with the ability of hauling 1,000 cyds per shift. Therefore, the trucks in this case are the bottleneck of 6,000 cy/shift, limiting production of the excavators.

Using the fixed order as the restriction scheme, we will limit the tail unit's production every shift that the excess excavator capacity exists. When the schedule is run, it checks the shift capacity for each shift as the program times out the progress. This slows the program down, showing a bottleneck window with the dates counting by, but keeps the production capacity in line with the desired production level. A report is generated showing which unit is reduced and by how much. An example report is shown here.
When the schedule is run and the map is hatched showing the progress, note the additional time periods for Units C and D. This shows Units C & D have been held back while the other units worked at full production. Unit D is not even working in some of the early months. There is a progress bar to show the time elapsed and time remaining for very large mineplans that take a while to run.
The report generated shows the production for a 30 day month at 3 shifts per day at 6,000 cyds per shift equals 540,000 cyds for the month, as in April below.

**Calculate:** This is the button to start the sequencing. Choosing this button will bring up a small window displaying the completion date. Or if the bottleneck parameters are being used, it will display the days counting down and the various Loops it is using in the calculations. There are two report choices shown here. The Report button will bring up the Equipment Report where the following parameters, such as start and finish dates and the days waiting or pit available are displayed. The Detailed Report will go into the Report Options Screen described next. This is the same as the Report button from the initial screen.
• **Report**: Selecting this will go into the Report Options screen. It should only be active if the Calculate button has been selected previously. This is where many settings in the schedule are set, such as the breakdown of the time periods, hatching etc. The Report Options is defined next.

**Report Options.** Each item on the dialog box is defined below.

- **Report by period**: This option runs the schedule and breaks the pits into blocks by period, such as month or year. The blocks and outlines are colored by period and displayed in the report. The report can be formatted...
may ways.

• **Report by equipment**: This option runs the schedule and breaks the pits into blocks by Equipment. The blocks and outlines are colored by equipment and displayed in the report. The report can be formatted may ways.

• **Report Only**: Choosing this option will not draw any blocks or outlines on the map. It will go directly to the Report Formatter for viewing of the data.

• **Draw blocks**: When this option is selected, the periods or equipment will be drawn as blocks of solid fill or any AutoCAD hatch pattern that is chosen.

• **Draw distinct outline**: When this option is selected, the periods or equipment will be drawn as closed polyline outlines.

• **Draw legend**: This option draws a legend and the picked location on the map. The colors are based on period, custom amounts or equipment.

• **Pastel colors**: Choosing this option draws the blocks or outlines in the pastel color region of the AutoCAD palette. It uses colors in the 11, 21, 31, 41 etc. row. If it is not selected, then it will use the brighter, primary colors such as 10, 20, 30, 40, etc.

• **Enforce custom colors**: Selecting this option will use the custom color palette the is setup with the Custom Dates and Colors Table.

• **Custom table: Dates/Colors**: This brings up the Define Ranges screen. This is where a custom date or color table can be set up. The Auto set button will bring up the smaller window for entering the starting line (row number), starting date, how often to repeat, and how long to keep repeating. The Set colors will prompt for a starting color, and the color number increment. The colors are set by picking the color box. The Pattern is the pattern of the hatch in the blocks. The Scale is the size of the hatch patterns if a hatch is used. The Layer is the AutoCAD Layer of the period. Finally, the Label is what each period will be called for reporting and labeling. The example shown here has created a weekly schedule with custom colors. The Clear button wipes out the data for starting over. The tables can be saved and loaded as CDT files. To use this option, choose Enforce Custom Colors or Custom Date Table.
Custom table: Amounts: This button brings up the Define Levels window. This is where the amount to target is set for the Custom Amounts option in the report. The amount to target is set in the first column. The next column is the color for the blocks and outlines. The colors are set by picking the color box. The Pattern is the pattern of the hatch in the blocks. The Scale is the size of the hatch patterns if a hatch is used. The Layer is the AutoCAD Layer of the period. Finally, the Label is what each period will be called for reporting and labeling.
• **Change shade color every:** This option will change the color/layer of each block or outline. There are 3 choices. Every Period (what is selected below), Year, or 5 Years.

• **Block labeling:** This pull-down is for setting the labeling options. There are 5 options here. No Block Labels will not draw any labels. Draw Actual Dates will draw the date of each period. Draw Period Names will place the period name in the block that is entered in the custom date table. Use Custom Names draws the names entered in the custom amount table. Use Custom Text Block activates the Add, Edit and Remove buttons. Choosing Add or Edit will bring up the input screen for arranging the text items in the block. First, give the new block a name. Then move items from the left side to the right, in the row desired. The Add Text button allows for custom text for prefix or suffix entry. The Add Attribute adds any attributes that exist in the schedule. Add New Line moves the added item to the next row. If this is not selected, then the next item is added to the same row, with a + as a separator. Remove will move the entire row from the Line definitions.

![Define a Text Block](image)

• **Text Size/Text autosize:** This will either place all text in the map with the defined size, or autosize it to fit in the block dimension.

• **Length-wise labels:** This option draws the text parallel with the long axis of the pits. If it is not selected, then the text will be 90 from the long axis.

• **Text Style:** Enter in an AutoCAD text style for labels.

• **Text Block Style:** This section is active if the Block labeling is set to Use Custom Text Block. Any premade blocks will appear on the list and may be selected for text orientation.

• **Report Period:** This is the start and finish date of the report. By default, the program will display the full range from the start date to the final date it needs to finish. Any date range in the middle may be used.

• **Skip format prompt:** If this option is selected, then after the blocks are drawn, a report will appear that is similar to the last one created. The program will not bring up the report formatter for customizing.

• **Sub-divide by properties:** If this is selected, the schedule will recognize any named Carlson property lines drawn on the mineplan. In the report, the periods can be further subdivided by property and owner. These are the same property lines that are used in Surface Mine Reserves.

• **Output period grids:** Choosing this option will create a grid file of the 3D surface at the end of each period, such as a month or a year. It needs the Surface Grid and the Bottom of Pit Grid. It needs at least the Bench 1 Grid filled in to make the grids. The Bench Grids will come in automatically from the Pit Attributes, where the SURFACE attribute is defined as the topography, and each benches bottom elevation is defined as SURFACE_BENCH*. If they aren't define in the Pit Attributes as such, then each grid will need to be
selected here. A new output grid path with an Output Grid Prefix is set to create new grids of each period. A new grid file is then written of each period for the pit and bench. This can be an "ultimate pit" used in other design work. It doesn't have the flexibility of other commands such as Design Bench Pit, but it gives a 3D surface of each period mined. It uses a constant highwall slope of around 80 degrees, but varies based on the grid cell size.

• **Period Polylines to Pits:** Selecting this option creates and names the outlines as Carlson pits. The names of the pits are the actual period names. This is useful if these period polylines need to be saved and re-run in the Surface Mine Reserves for additional quantities or analysis.

• **Output Spoil File:** This option creates the SPO file that is used for the timing of the spoil commands found in the Spoil menu. This output contains the nonkey waste for spoil placement and timing.

• **12 months + 8 quarters + years:** A schedule run with this option will break down the first year into 12 monthly periods, the next two years into 8, 3 month quarters, and the remaining periods will be full years.

• **Show Months of Development:** This method will use the starting day and increment by month to the same day. For example, if the starting day is on the 12th of each month, the schedule will be from the 12th to the 12th for each month.

• **Show 1st Days of Months:** This method will use the starting day and increment to the first of each month. For example, if the starting day is on the 12th of the first month, it will go to the end of the first month and then start fresh on the 1st of each month.

• **Show Years of Development:** This method will use the starting day and increment by year to the same day. For example, if the starting day is on June 15th, the schedule will be from June 15th to the next June 15th.

• **Show 1st Days of Years:** This method will use the starting day and increment to the first of each year. For example, if the starting day is on June 15th, it will go to the end of the first year and then start fresh on the 1st of each year.

• **Show Date Range:** This option is used to just display a period as a partial range. Enter a range above in the Report period windows. Then when the sequence is run, only that period will be hatched all in the same color and time.

• **Custom Date Table:** When a custom Date/Colors table is defined, this option must be selected to use it. Custom Dates/Colors are defined above.
Custom Amount Table: When a custom Amount table is defined, this option must be selected to use it. Custom Amounts are defined above.

Legend Scale: If the Draw Legend box is selected, this is the size of the legend. Sizes from 50-100 should appear legible for most mineplans with a dwg scale of 50.

Hatch: This is the hatch that is used for drawing in the blocks if the custom date or amount tables are not used. All hatch patterns appear on the list, the most common one, solid, appears at the top of the list for easy selection.

Retreat Hatch: This is used for underground retreat hatching. Disregard for surface mining.

Divide advance/retreat display: This is used for underground retreat hatching. Disregard for surface mining.

Scale: If a hatch pattern other than Solid is used, this is the scale it will be drawn at. Sometimes trial and error is needed to get the best scale, as different patterns look better at different scales.

Layer: This is the AutoCAD layer that the blocks and outlines will be drawn in, if no other options are used.

Layer by year: The blocks and outlines will be layered by year. The year will appear as a suffix to the layer name.

Layer by period: This option will put each period on its own layer. If there are many periods, it will create many layers which can be a hassle.

Of, Sum for whole mine & Stop at last period: These options are only active when using the Custom Amount Table. The "Of" window is for selecting what is being target for custom amounts. The options are similar to Surface Production Timing: Total Tons, Key Tons, Waste Tons, Total Area, Mined Area, Total Volume, Waste Volume, and User Grid. Sum for whole mine will keep a running total for summation in the report. Stop at Last Period will end the schedule at the last entered row in the Custom Amount Table entered above.

Split Report by Strata Fractions: This option will utilize the tonnage and volume factors stored as pit attributes and report out the volume and tons of each named seam, not just composite Key Tons and Nonkey volume.

Multi-Bench Mining Example Setup:
The defining of equipment, crews and equipment calendar are (potentially) one-time operations. Similarly, the making of the "Pre-Calc Grids" geologic model need be done only once in advance of numerous timing runs. Surface Equipment Timing, also distinct from Surface Production Timing, allows multi-bench mining by use of different equipment or the same equipment mining different benches, with different production rates. Since single-bench mining is a subset of multi-bench mining, this will illustrate the command with a multi-bench example. Surface Mine Reserves is one of three methods to place quantity and quality information into the pits, by bench. This example will use Surface Mine Reserves. If there are two benches, Surface Mine Reserves must be run twice, one time for each bench. The dialog within Surface Mine Reserves should be completed as follows for Bench 1:
The key is to choose "Selected" strata (for benching) as well as "Use Named Pit Areas" and "Store Results in Pits". You should also select "Calculate Strata Qualities" to assign quality information to the pits. If single-bench mining is conducted, you may omit the "Selected" option. Other items in the dialog are set according to user preference.

Note the option "Output Thickness Grids". If this is not selected, total quantity and composited quality information is placed in the pits, and mining across a single pit is proportional. However, if the "Make Thickness Grids" option is selected, mining across the pits picks up the varying of the overburden thickness, coal thickness and quality information. For small pits or "blocks" as they are sometimes called, storage of total information will still lead to reliable results. Thickness grids are recommended for large and long pits, where the thickness will vary. The choice of "Selected" strata requires that the user select which strata will be mined in Bench 1. The following Choose Strata dialog at will appear:
Holding the CTRL or SHIFT key down, will select Overburden and C1 to mine down to the bottom of the first coal (C1). Bench 2 would be comprised of Parting and C2. Following two runs of Surface Mine Reserves, new information has been added to the pits. Pits contain up to three categories of information: pit name (verified by using "Identify Pit Polylines"), pit direction and pit quantities/qualities organized by bench. Pit quantities and qualities are needed only for Surface Equipment Timing, and can be verified using the command "Edit Pit". For example, the information in Edit Pit is shown below. Select the "Attribute" option to reveal the quality attributes.

You will note that Bench 2 has Bench 1 (referred to as TOPO-A-1-B1) as a "precedence" bench. In other words, you cannot mine Bench 2 unless you first mine Bench 1. Lower benches are automatically set to require prior mining of upper benches (The ordering of the mining comes later!). The Pit Attributes show any attributes set by Define Pit Attributes. Some may be seen here.

Assuming that a calendar has been established (multiple calendars can be saved and recalled), and assuming that equipment has been defined, we are now ready for Surface Equipment Timing. After selecting OK on the Mining Project screen, this is how the dialog appears prior to making any selections.
The first step is to "Add Equipment". In our two-bench mine, we will use one piece of equipment for the upper bench (overburden) and different piece of equipment for the lower bench (parting). Technically, separate equipment would probably be used to remove the coal, but in this example, the coal is not included in the schedule quantities, just uncovered reporting. In fact, a 4-bench mine could be set up that considers each of the two coal seams as separate benches. In reality, however, the overburden and parting removal rate will typically govern the overall progress of the mining. When "Add Unit" is selected, the following dialog appears.

Select the equipment and add them one at a time. The draglines used here are defined based on 3, 8 hour shifts (Shift 3 can be ignored if we plan on a 2-shift system). The "Availability" option can be used to de-rate the mining speed in the Edit Equipment. Any of the above items can be revised from within Surface Equipment Timing. The next step is to assign "Dragline" to Bench 1. It is best to Sort by "Bench, Pit" and then Select "Bench 1", using the options at middle right in the Surface Timing Dialog. These leads to the following appearance:
It is also important to note the option "Skip Coal for timing" at the lower right of the dialog box. Here you can base all progress on the NonKey overburden and parting only, on the assumption that the loaders or other equipment digging the coal will "keep pace" with the equipment removing the overburden and interburden. If "Skip Coal for timing" is not selected, the coal volume will be included in the total quantity mined by the equipment. We can add a second piece of equipment, then highlight it within the Surface Timing dialog and assign all the remaining pits to it (Select All or Bench 2, then Assign). Note also that we can add a delay between completing the Bench 1 pit and beginning the Bench 2 pit. Delays are automatically inserted below the highlighted pit, so if a pit is highlighted, a delay will be added below it that can be moved up or down also. There is a prompt to add this as a calendar or schedule delay (described above). Shown below is the assignment for Bench2.
To complete the calculation, fill in the Starting Date (if the default is not correct), then click on Calculate. This leads to a completion date and the option of a unit report or going directly to the Report Options screen. The Unit Report is very instructive because it highlights when equipment has been idled. Our Bench2 dragline is waiting each time for the "slower" Bench1 dragline to complete bench 1 before it can launch into bench 2. The planner could try lower rated equipment, or reverse the assignments of the equipment, or simply re-shuffle the assignments in any desired manner to maximize efficiency. The last step is to choose "Report" when returned to the Surface Timing dialog which brings up the Report Options dialog.

This example will show the first days of months. This leads to the final hatching shown below as bench 1 (the bench 2 layers were frozen for better appearance), as well as the quantity report which can be formatted many different ways and exported to Excel or Access:
Notes and Comments on Equipment Timing:
Equipment Timing can mimic Surface Production Timing through selection of "Custom Amount Table" at the base of the Report Options dialog. This would be an alternative way of getting to custom table amounts, since the equipment is removed from the equation and is therefore irrelevant. This will target tons of coal, yet report out how many dragline hours need to be scheduled to uncover the coal.

If there are multiple seams (both Key and NonKey) assigned to one bench, the program will report a tonnage and volume factor that applies to each strata. This factor can be used in the User Attributes to calculate the tonnage and volume of each separate strata instead of just a composite number of Key and NonKey.

While Surface Production Timing reports total quantities broken out by seams or specific strata, Surface Equipment Timing only reports totals for all key strata (e.g. coal) and overburden. However, Surface Production Timing does
report specific quantities (composited) for each bench. Therefore, our 2-bench mining example will report quantities for Bench 1 (coal C1) and Bench 2 (coal C2). With sufficient benching, the individual strata quantities are retained. For one-bench mining, all multiple strata are composited in the final report.

To practice "what-if" scenarios, use "Undo Report" within the Surface Timing dialog, which will remove the colored hatching, allowing revision of equipment assignments and another practice run.

**Prompts**

Select all pit polylines.

Select objects: *Pick all polylines*

**Pull-Down Menu Location:** Surface Mining menu, under Surface

**Keyboard Command:** timepit

**Related Commands:** Surface Mine Reserves, Assign Directions, Surface Project Manager, Assign Timing Grids, Import Timing Data, Define Pit Attributes

---

**View 3D Surface History**

This command allows you to modify and playback the grid sequence history generated by several Carlson commands. The command initially displays a list of grid files in the sequence. You can add more grids, modify grid colors or change the grids order. When editing is complete, pick the OK button which brings up the playback 3D viewer window.

In the bottom part of the window there is a row of buttons allowing user to move from step to step in a grid sequence. On each step the grid displayed has elevations of the grid assigned for that step and the color of the last grid when the elevation at a particular location changed. For example the unaffected regions will have the color assigned to surface grid.

The row of buttons at right controls the view response to mouse drags and the shading. The zoom button activates zoom mode, where if you hold left mouse button and drag the mouse pointer up or down the picture zooms out or in correspondingly. In the rotate mode, the horizontal drag rotates the X axis (around Y), the vertical drag rotates the Y axis around X. The circular movement along the periphery of the picture rotates picture around the Z axis.

When pan button used, the picture will pan if mouse is dragged with the left button pressed.

The shade button turns the shading of the grid on or off.

This GSQ file can be used in Surface Mine Reserves to automatically calculate the quantities by bench for the pits with highwalls.

**Prompts**

**Grid Sequence File file selection dialog** Choose the .gsq file to update.

---

**Here are a couple of examples:**
Removing the coloring after the timing routines are completed may be a tedious task. This routine removes and erases all text labels and hatching from surface pits and underground panels for a specific bench or mining direction.

**Clear Timing Report**

Removing the coloring after the timing routines are completed may be a tedious task. This routine removes and erases all text labels and hatching from surface pits and underground panels for a specific bench or mining direction.
in one step. It is a quick and efficient procedure, even for objects on many layers. Items are permanently removed from the drawing screen. It supports both surface and underground mining.

Prompts

For Surface Timing:

Enter Bench Number to Remove coloring for (Bench Number/<All>):
Select parts of mineplan to have timing coloring removed:
(Bench Number/<All>): press Enter

Pulldown Menu Location: Surface
Keyboard Command: utime_clear, stime_clear

Haul Fleet Manager

This command manages the haul truck fleet. There are about 20 trucks included with the program by default, and other trucks can be added based on the type used on site. These input values are based on basic fuel and performance comparisons and applied to all trucks in general. Most mining trucks have about the same haul speed, plus or minus 3%-5%, or only a few mph or kph. What does vary is the engine size, road conditions (Effective Grade) and speed. The Effective Grade % is the Actual Grade + Rolling Resistance. The input screen appears as follows.

Resistance data for the highlighted truck appears below, and is in columns for Total Resistance %, Loaded Fuel Duty Cycle %, Loaded Operating Speed, Empty Fuel Duty Cycle % and Empty Operating Speed. Speed will be in mph or kph, and is determined by the setting under the CAD Drawing Settings.
Saved trucks are put into the text format as shown here. Any new trucks can be entered as ASCII text and imported.
The following graph illustrates the relationship between fuel and speed performance, and is how the Resistance Data table is populated. This will allow for user entry of new trucks, if a new truck is added with the green "+" button.

Once the engine size and effective grade is known, the haul speeds and fuel duties for both loaded and empty are derived. This allows for estimating time and net fuel consumption. For example, here is how it is calculated.

Truck Engine = 1491kW
Engine Duty = 100%
Fuel Consumption = 0.25 (l/kW) * 1491 (kW/h) * 100% = 373 (l/h)

The data can be fine tuned with real dispatch information from mining operation.

- Thank you to Peter Nahan of Goldcorp for his suggestions, references and help in developing this command.

**Pull-Down Menu Location:** Reserves/Timing in Surface Mining

**Keyboard Command:** haul_fleet

**Haul Road Manager**

This command builds and links the haul road network, recognizing 3D polylines and adding them to the network. All possible roads must be drawn as 3D polylines in CAD, either draped onto the surface model, or snapped to contours. Individual layers can be used for clarity to see the roads in the manager by color and layer. There aren't any tagged segments to select the first time this command is run, so the preview image will be blank. The segments must be added by picking the green "+" button to bring them into the editor.
• **Preview Window Display:** The upper preview window has four buttons for Pan, Zoom Realtime, Rotate and Zoom Extents.

• **Add Segments:** Selecting the green "+" button will prompt for selecting the 3D polylines in CAD to add to the haul road network. This must be done initially if there are no segments found.

• **Remove Segment:** This green "X" button will remove the highlighted segment from the manager.

• **Pick Segments:** The Select from Screen, Pick Segments button is used to pick already named haul road segments, and add them to the manager. They must be already tagged with the Add Segments for them to be recognized.

• **Split at Grade Break:** Selecting this button will split the haul roads into smaller segments, based on the percent grade tolerance so that each segment is within that slope tolerance. This isn't a requirement, but the idea is to have segments with constant grade as the truck speed is depended on the grade of the road, and this will divide the road into smaller segments if desired. This will also break the 3D polylines into the smaller segments, so it is recommended to Save the drawing as a new name before breaking, so that there is a back up to go back to if necessary. There are two dialogs that appear from this command. It will only break the highlighted segments, so it is easy to control which roads are being divided.

![Split Segment at Grade Break Dialog](image)

![Selected Segment Split Dialog](image)

• **Delay Points:** These are point symbols inserted into the drawing the will trigger a delay event for the specified number of minutes. Examples would be a stop sign at an intersection, or a one lane bridge where trucks have to stop. Any symbol from all of the libraries can be inserted to represent the location. These delays will be accounted for when the trucks pass over that spot.
• **AutoSet**: The AutoSet Segment Parameters based on Grade option colors all the haul roads based on their percent slope. This is an option to graphically see the slope of each road, simply by the color it is drawn in. This will also change the color of the 3D polylines in the plan view. They will stay on their original layers, so they can be set back to color ByLayer if desired. The slope interval was set here to a 1 or 2%, starting at -5%, as an example.

Notice in the image below, that the new colors are set by the percent slope of the road. These colors are now different than the initial image where they were colored by the layer.
Now that the haul roads are defined in the manager, they can be used in the haul road processing commands.

**Pull-Down Menu Location:** Reserves/Timing in Surface Mining  
**Keyboard Command:** haul_roads

**Haul Cycle Analysis**

This command combines the haul routes and the haul fleet and calculates the time and distance of all the possible travel routes. It utilizes the predefined haul road routes, and the trucks from the haul fleet for analysis. The initial prompts are to select the beginning point and ending points for the truck route. These are usually the loading and dumping locations. The order they are selected is not important, as there is an option to define if the truck is starting as loaded or empty. All slopes and distances are taken into account based on the original 3D polylines of the truck routes. This is a very automated routine. Once the starting and ending points are selected, the dialog displays all the possible road routes. They can be sorted by length, segments, time, or any of the column headers by clicking on the header buttons. When each road is highlighted in the spreadsheet below, the route is shown above in the plan view, as bolder, thicker lines. Many different types of reports are generated leading aiding in the haul truck network design.

- **Assign Haul Truck:** The dropdown displays the list of trucks to choose from. Select the truck to analyze and run through the route. The Fleet button will bring up the original dialog where the truck fleet was created, for
• **Truck Starts (Loaded or Empty):** This option determines whether the truck begins the route at the loading or dumping location. This will be used in the route where the direction of travel, and slopes are accounted for either empty or loaded.

• Calculate (Fleet Size or Production): There are two main parameters to solve for, the number of trucks or the tons per hour hauled. Changing this option will make difference on the appearance of the main dialog. The default is Fleet Size, where it will calculate the number of trucks needed to meet the production. Changing this to Production will allow for entry of the number of trucks to use, and then calculate the tons per hour that can be produced/hauling. These changes are shown in red here.

• **Production Rate or Number of Trucks Used:** This input will be what controls the calculated output. Either enter in the tons needed per hour, or the number of trucks that will be used. Everything is linked, so changing the number of trucks will recalculate the production, allowing for fine tuning the planning process.

• **Estimated Queuing Time:** This is the time in seconds for the truck to add to the turn around point for loading or dumping.

• **Minutes per Production Hour:** This is the actual number of minutes per hour that the truck is hauling. Factors such as shift change, breaks and other delays can be accounted for here.

• **Truck Filling Efficiency %:** This is the average percentage of the trucks load capacity. For example, if it is a 100 ton truck, and the filling efficiency is 94%, then each truck will haul 94 tons on average.

• **Truck Availability X Utilization:** Another variable to account for availability and utilization can be entered here. This percentage is multiplied by the minutes per production hour to determine the overall working time.

• **Use Report Formatter:** This option will use the Carlson Report Formatter instead of just the text window. This allows for more custom report building.
• **CAT FPC Reports:** There are 3 types of CAT FPC reports this will create. The ASCII, GPS and Course Reports are shown here with their examples.

CAT FPC ASCII Report Example:

![CAT FPC ASCII Report Example]

CAT FPC GPS Coordinates Report Example:

![CAT FPC GPS Coordinates Report Example]
• **Cycle Report**: This standard report will use the Report Formatter, or the Text Window to display the calculated and entered data.
Prompts

**Delay: Intersection Merge** (will be a pre-named delay name)

[near on] **Pick start point on Haul Road:** select where the truck will begin, usually where it gets loaded at.

[near on] **Pick end point on Haul Road:** select where the truck will end, usually where it unloads/dumps at.

**Pull-Down Menu Location:** Reserves/Timing in Surface Mining

**Keyboard Command:** haul_cycle

**Surface Menu**

The Surface menu has commands for cross section and surface modeling.
Define Dragline Equipment

The description of available draglines is created and edited using this function. While the most important parameters are those which define dragline operational range for the Cut and Place commands, there is a number of others which are used in the 3D dragline modeling. Bucket size is used to calculate a number of cycles needed to transport a given amount of material, which is used to get the time spent on material handling, together with swing speed and calculated average swing angle. Dragline house sizes are used to estimate how the dragline travels within a given area, while maximum speed gives the time required to complete these moves. Finally, if operational cost is specified, the total cost will appear in the final report. The first screen shows the draglines that are defined within the program.

Choosing Add or Edit will bring up the next screen. Notice the Required Sizes section. These must be all filled in. The remaining windows are all optional. Defaults will be used if they are not defined in the 3D Dragline command. Depending on the Drawing Setup, either CY and FT, or CM and M are displayed as the units to enter. Carlson saves this information in the "dragline.dta" file in the USER folder of Carlson. The Save and Load buttons of the main dialog allow you to save and recall the dragline settings to a .DLN file.
The Save and Load buttons allow you to save and recall the dragline settings to a .DLN file.

**Prompts**

*Edit Available Draglines and Dragline Specifications dialogs.*

**Pulldown Menu Location:** Surface  
**Keyboard Command:** edit_draglines  
**Prerequisite:** None

**3D Dragline**

This command gives a 3D approach to the design and placement of dragline pits. Unless all the seams are perfectly uniform and horizontal, and pits are straight, the usual cross-section dragline modeling with range diagrams will not provide the appropriate level of precision and visualization. This function allows you to specify the cut and spoil areas and watch the ground surface change in 3D. Surface updates are recorded on every step and may be played back later.

The first step is to define the three grid files at the top of the Dragline project window. They are the original topo grid file, the final grid file (create a new grid if one doesn't exist) and the top of the Key strata grid file.

The Dragline parameters section is for choosing the dragline. Then set its Efficiency %, Fill Factor %, Fill time (seconds) and Dump time (seconds). The Slope and Swell factor are set next, in the center of the screen. Slope is...
either set as ratio or percentage. A swell factor of 1.3 gives 30% swell.

Finally, on each step of the sequence, three pre-drawn closed polylines are chosen: a polyline enclosing the area within which dragline is allowed to move, a bottom of cut area polyline (usually the next pit line), and a top of spoil area polyline (usually the previous pit line). The program then offsets the dragline polyline by the maximum reach distance and crops out the portions of cut and spoil polylines within the dragline reach. These modified polylines will be used in calculations. This allows the program to use larger cut and spoil polylines and move only the dragline on each step.

The program then calculates the overburden volume by using surface grid on top, coal top grid on bottom, and the highwall calculated using the cut polyline and given cut slope. The cut polyline is projected onto the bottom grid prior to calculations. The swell factor is then applied to the freshly cut material, while the rehandled material amount is taken as is. If the spoil polyline is a 3D polyline, its profile will be the elevations of the polyline. Otherwise the spoil ridge is considered to be at the same elevation. The spoil polyline is then moved up and down until the amount of the material between the spoil pile and the existing surface matches the given amount. If any dragline parameters are too small to physically mine here, then error messages, are displayed accordingly.

The calculated cut, spoil, rehandle and timing results are then displayed in the dialog. You may then modify the selection of cut, spoil or dragline polylines and proceed to the next step, or use the Stop button to exit. With use of the history file, the scheduling may be restarted from the point it was finished. Surfaces are updated with each step. To get to the next step, simply select then next 3 polylines, change the first two grid names (the top of coal usually remains the same) and choose next. After each step, the report formatter appears, allowing for customized reports of the steps.
Dragline project, Step #1

Original grid file: C:\DRAWINGS\SURFACE TUTORIAL\GRIDS\SURFACE GRID shocked
Final grid file: C:\\DRAWINGS\SURFACE TUTORIAL\GRIDS\3D_Diag.gdf
Key strata grid file: C:\\DRAWINGS\SURFACE TUTORIAL\GRIDS\C1_KEY_EL2_Grid

Dragline parameters:
- Dragline Make/Model: BUCYRUS-ERIE @ 1570
- Efficiency: 0.70
- Fill factor: 0.90
- Avg. fill time: 10.00
- Avg. dump time: 10.00
- Cut slope: 1.30
- Spoil slope: 0.83
- Swell factor: 1.20
- Cut Volume: 2701206.14
- Spoil Volume: 3244447.36
- Rehandle: 0.00
- Avg. Swing: 147.20
- Avg. Travel: 0.00
- Cycles: 49022.00
- Time Spent: 381.13

Key strata grid file:

Slopes:
- Cut: 0.77
- Spoil: 1.20
- Swell factor: 1:30

Step results:
- Cut, c.y.: 2701206.14
- Fill c.y.: 3244447.36
- Rehandle c.y.: 0.00
- Avg. swing: 10.9
- Avg. travel, mi: 0.00
- # of cycles: 52024
- Time spent, hrs: 381.13
3D View of the first step
The grid has been colored by elevation to show the ranges better.

Prompts

Create or choose the DHT file. (Dragline history file.)
Dragline project dialog

Pulldown Menu Location: Surface
Keyboard Command: cut_n_drop

Range Diagram
The Range Diagram command is an interactive tool that displays graphics which are dynamically updated when adding or editing values in the spreadsheet text below. This is a quick and easy way to find parameters such as pit width, or to size a dragline to fit the geology. Output includes both drawing the sections in CAD and printing out reports as PDF files, where each step is a separate page. Each option is detailed below.
**Input Parameters**

- **Top Elevation:** Sets the top elevation of the ground surface
- **Pit Width:** Sets the width of the open pit. This could be the previous pass, or a boxcut
- **Spoil Angle:** Sets the angle of repose of the spoil pile
- **Cut Width:** This parameter is the width of the new cut. This is the field that is frequently changed to see what pit widths will work
- **Cut Direction:** This determines whethere the cut is advancing to the right or left in the graphics window. It is just a mirror image of either.

**Dragline and Seam Data**

- **Dragline:** This dropdown displays a list of predefined draglines. These can be added and edited with the separate command Define Dragline Equipment.
- **Reach:** This displays the horizontal reach of the selected dragline. Since it is colored blue, it cannot be edited here.
- **Max Height:** This displays the vertical dumping height of the selected dragline. Since it is colored blue, it cannot be edited here.
- **Max Depth:** This displays the vertical digging depth of the selected dragline. Since it is colored blue, it cannot be edited here.
- **Swing Angle:** This parameter controls the swing of the dragline. Enter in values from 0-90 degrees.
- **Offset from Crest:** This sets the distance for the dragline center pin offset from the crest of the highwall.
- **Strata:** This is the list of strata added to the cross section.
• **Key**: The Key setting controls whether it is waste (NO), and coal (YES).

• **Thickness**: This is where the thickness of each strata or bench is entered. The section will update graphically when a new value is entered.

• **Face Angle**: This setting controls the highwall angle of each strata. It will update graphically with any change here.

• **Swell%**: This is the swell factor of the material as it is moved from in-place to the spoil.

• **Spoil**: This option controls whether to place the waste into the spoil with the dragline. If it is pre-stripped and hauled away, or interburden removed with other equipment, then the setting here would be NO.

• **Key Cut**

  • **Cut**: The Key cut gives the option to split the overburden block into two sections. The choices are None, Left or Right. An image of Left and Right is shown here. This allows for moving the dragline to get more spoil distance.

  **Left Key Cut**

  ![Left Key Cut Diagram](image)

  **Right Key Cut**

  ![Right Key Cut Diagram](image)
• **Width**: The width is entered in to set the horizontal distance of the Key cut.

• **Angle**: This is the angle of the key cut highwall.

• **D/L Offset**: This is the distance for the dragline center-pin from the crest of the highwall. It is usually more than the initial offset defined above.

• **Spoil**: This option determines whether to spoil or not. If it is hauled away by other equipment, then this should be NO. If it is spoiled with the dragline, then it should be YES.

• **Add Dragline (+)**: This option places the dragline on another strata. It can be the same dragline on another pass, or it can be another dragline if there are more than one working in that pit. Additional Draglines or passes show up as different tabs below the spreadsheet. Shown here is the same dragline as dragline2, working on the IB3 seam on another pass deeper in the pit.
- **Remove Dragline (-)**: This takes away the dragline tab that was added to the diagram.

- **Add Strata (+)**: Use this button to add each strata to the diagram, such as OB, Coal or interburden. Once it is added, then pick in the cell to give it the proper name.

- **Remove Strata (-)**: This takes away the strata that was added to the diagram.

- **Move Up or Down**: This moves the selected strata up or down in the section.

**Graphics Window**: The ground surface is color coded. When it is green, then the spoil will fit into the pit and not cover the coal.

- **Pan**: Pans around in the window

- **Zoom**: Zooms in and out in the window

- **Zoom Extents**: Zooms the diagram to fit the entire display window.

- **Settings**: This button brings up the following dialog for settings:
– **Show Current Dragline Only**: This should be on to see the dragline locations with a Key Cut, and also to see the other dragline locations on other passes.

– **Label**: These options will label the angles, distances, thicknesses and strata names in the display window.

**Output**: The output shows up in the lower right. It displays the area of the cuts and fills, as well as dimensions of each step in the section.

```
<table>
<thead>
<tr>
<th>1. Remove Key Cut OB 2570 &amp; RE AT CEDRUN</th>
<th>2. Remove OB 2570 &amp; RE AT CEDRUN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Area: 5672.5</td>
<td>Cut Area: 6227.5</td>
</tr>
<tr>
<td>Spoil Area: 6607.0</td>
<td>Spoil Area: 9993.0</td>
</tr>
<tr>
<td>Spoil Height: 73.4</td>
<td>Spoil Height: 129.2</td>
</tr>
<tr>
<td>Toe Offset: 30.6</td>
<td>Toe Offset: 3.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. Remove Seam1 2570 &amp; RE AT CEDRUN</th>
<th>4. Remove TB 2570 &amp; RE AT CEDRUN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Area: 2100.0</td>
<td>Cut Area: 2100.0</td>
</tr>
<tr>
<td>Spoil Area: 2520.0</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Spoil Height: 138.5</th>
<th>Toe Offset: -1.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>5. Remove Seam2 2570 &amp; RE AT CEDRUN</td>
<td>6. Remove TB2 2570 &amp; RE AT CEDRUN</td>
</tr>
<tr>
<td>Cut Area: 3050.0</td>
<td>Cut Area: 5125.0</td>
</tr>
<tr>
<td>Spoil Area: 7350.0</td>
<td>Spoil Area: 7350.0</td>
</tr>
<tr>
<td>Spoil Height: 177.7</td>
<td>Spoil Height: 177.7</td>
</tr>
<tr>
<td>Toe Offset: 184.1</td>
<td>Toe Offset: 184.1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7. Remove Seam3 2570 &amp; RE AT CEDRUN</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut Area: 3120.0</td>
<td></td>
</tr>
<tr>
<td>Total Spoil Area: 26670.0</td>
<td></td>
</tr>
</tbody>
</table>
```

**Draw**: This option will draw the steps in CAD as polylines with fill. It will prompt for the starting point in CAD to draw them. Exit the command to see them in CAD. Here is an example of what it draws, their colors and entities.
**Report**: The report button will create a PDF document where each step in the section will be on a separate page. Then at the end, one final page will show all the steps together with the finished section.

**Pulldown Menu Location**: Surface

**Keyboard Command**: ranged

**Prerequisite**: dragline equipment defined
Dozer Push

This command calculates the volume and distance moved for a dozer push from a highwall into a pit. The program also draws closed polylines that represent the cut and fill areas and the path of the dozer. Dozer Push works with a cross-section view of the pit. Before running this routine, you need a polyline that defines the existing ground including the top surface, highwall and pit bottom. A second polyline is optional for the Cut Bench to push along and also optional is one for the bench bottom. The Cut Bench polyline could be the top of coal for example.

The Dozer Push command starts with the dialog box shown here:

- **Horizontal Scale** and **Vertical Scale**: These are the scale factors for the drawing to generate text, symbols, and vertical exaggeration, among other things.

- **Cut Push Percent**: Push Percent is the percent grade the dozer cuts down from the surface. Enter as a percent.

- **Pit Push Percent**: The Pit Push Percent is the percent grade that it will push out into the pit before spilling over to the repose angle. Enter as a percent, positive or negative.

- **Repose Angle**: Repose Angle is the angle that gravity pulls down the fill slope, as it spills over the edge. Enter as an angle.

- **Wedge Angle**: Wedge Angle is angle the dozer will cut down when the Use Wedge Angle option is on. Enter as an angle.

- **Spoil Percent**: Spoil Percent is the percent grade of the spoil pile as the dozer pushes uphill. Enter as a percent (up). When there is not enough room in the pit to fit the cut at the pit push percent, the remainder will get placed by building up a spoil pile at this specified Spoil Percent. The program will prompt for a base point to start building the spoil slope. This point is typically at the top of the coal so that the spoil pile will not overlap the coal and create extra rehandle.
• **Cut Swell Factor:** The Cut Swell Factor is multiplied by the cut to determine the amount of fill. Enter as 1.2 for 20 percent swell.

• **Sequence Number:** This is the sequence step number that is added to the SEQ sequence file for Process Dragline Sequence.

• **Direction to Push:** The dozer must be specified to push to the right or to the left.

• **Define Cut Depth By:** The Polyline Method will prompt to select the Cut Bench Polyline. This is the surface that the dozer will cut down to. The dozer cut will be located by finding the top of the pit and then moving back along the top surface for the Cut Width entered below. The top of the pit is identified by finding the first grade that is greater than or equal to the Push Percent grade. Then the dozer will cut down at the Push Percent until it reaches the bench polyline. The Pick Points method will prompt for the lower left point and the lower right point. The line drawn between them is then set to the cut surface. This controls the cut width, so the value entered below for Cut Width will not be used.

• **Output Step to Sequence File:** Turn this option on to add the step to a new or existing SEQ file. This file is processed with Process Dragline Sequence.

• **Store Step to Report File:** This option will create or append a CUT file that is processed with the command Dragline Section Report.

• **Find Cut/Fill Balance:** The Find Cut/Fill Balance is a special option that finds the offset distance where the cut and fill balance and draws the push polyline. With this option, the bench polyline is not used.

• **Label Push Distances:** This option will label the distance from the centroid of the cut block to the edge of the highwall where the repose angle.

• **Cut Width:** When using the Polyline method to Define the Cut Depth, this is the total width of the push, from the Cut Push distance down to the Cut Polyline, then across the Cut Polyline the remaining distance to get to the entered width.

• **Use Wedge Angle:** With the Wedge Angle option, the cut will begin by starting at the top of pit and moving down at the Wedge Angle for the specified Cut Width. It will continue down at the wedge angle for the specified horizontal width. The Cut Push Percent is not used if the Wedge Angle is used.

This command does one push at a time. To perform multiple cuts, run Dozer Push for each one. For every push, a cut area and fill area are drawn as closed polylines. The ground polyline and bench polyline are also updated to represent the modified surface. The centroids of the cut and fill areas are used to calculate the push distances. During a stage of the dozer push, there might be rehandle where some of the cut area includes previous fill areas. There is an option to deal with rehandle by selecting the closed fill area polylines that were drawn in a previous Dozer Push. The amount of rehandle is reported and the swell factor is not applied to the cut in rehandle. When there is not enough room to drop the push into the pit, the fill needs to be pushed up to a spoil pile. The program automatically detects this case and prompts for the bottom bench polyline for the spoil start. The end of this polyline is where the spoil grade begins.

Shown next are some dozer push examples with the important points labeled.
Prompts

This command handles many stages of the dozer push. Which values to use from the dialog and the prompting depend on the stage of the dozer push.

Select existing grade polyline:
Pick lower Left cut point:
Pick lower Right cut point:
Select fill areas to rehandle (Enter for None).
Select objects:
CUT (bsf): 9182.6 REHANDLE (bsf): 0.0 FILL (lsf): 9182.6
PUSH: 141.4,3.6%
Pick Point for Label (Enter for none):
Select existing grade polyline: pick the ground polyline
Select cut bench polyline: pick the bench polyline
Select fill areas to rehandle (Enter for none)
Select objects: press Enter
Cut: 308.7 Fill 308.7
Pick Point for Label (Enter for none): pick a point
Select existing grade polyline: pick the ground polyline
Select cut bench polyline: pick the bench polyline
Select fill areas to rehandle (Enter for none)
Select objects: pick the rehandle polyline
Select objects: press Enter
Pick Point for Label (Enter for none): pick a point
Select existing grade polyline: pick the ground polyline
Select cut bench polyline: pick the bench polyline
Select fill areas to rehandle (Enter for none)
Select objects: pick the rehandle polylines
Select objects: press Enter
Select bottom bench polyline for spoil start: pick the bottom bench polyline
Pick Point for Label (Enter for none): pick a point

Pulldown Menu Location: Surface
Keyboard Command: dozer
Prerequisite: Surface and strata polylines

Draw Dragline Limits
This command draws an outline in profile view of the dragline reach, depth and height limits. The program draws the limits of the dragline as polylines in the current layer. These limit polylines serve as guides in other dragline commands like Cut & Place. Also, these dragline commands will check the dragline limits and report if the dragline limits are exceeded when processing the sequence file. The dragline parameters are set in the Define Dragline Equipment command. Before starting this command, the dragline should be defined in Define Dragline Equipment and the surface where the dragline sits should be drawn as a polyline in profile view. This polyline can be drawn with the Draw Fence Diagram command or the profile commands in the Civil Design module.

The window prompts for the horizontal and vertical scale. This is to determine the vertical exaggeration if any. There is an option to draw an icon of the dragline. Otherwise, the limits are only drawn as polylines. Choose a direction for the boom to be facing, left or right. The draw swing angles option will label the angles along the top of the limit polyline. The Group Dragline Entities will keep it together as a block instead of individual polylines. If the program detects that dragline limits are already in the drawing, then there is an option to erase the existing limits. This option is useful for automatically erasing old limits before drawing the new limits, as the program tracks where the dragline is located to measure the reach. Then pick the surface polyline and where along the polyline the
dragline is located. There is an option to specify the dragline location by picking a reference point such as the top of the highwall and then entering an offset distance from the reference point to the center pin of the dragline (left offset is a negative value).

**Prompts**

**Draw Dragline Limits Dialog**  
**Choose Dragline dialog**  
**Erase old dragline limit polylines [Yes/No]?**  
**Y for Yes if it is in the drawing**  
**Select ground polyline:** pick the polyline  
**Pick reference point (Enter for None):** pick a point  
**Dragline distance from reference:** -50 Negative for left, positive for right.

**Pulldown Menu Location:** Surface in the Mining Module  
**Keyboard Command:** dlimits  
**Prerequisite:** Surface polyline in profile view

**Cut and Place (Spoil Removal)**

This command removes a cut area in cross-section view from a surface polyline and places a spoil pile of this area. Before starting this command, the surface should be drawn as a polyline from left to right. One way to draw the polylines is to use the Fence Diagram routine. In Fence Diagram use the option to draw the polylines as single polylines instead of closed polylines (with no hatching). Also, if there is an existing pit, turn on Draw Surface Polyline to make sure the surface line extends across the pit floor. The Draw Dragline Limits command can optionally be run before Cut & Place to draw an outline of the maximum reach, height and depth of the dragline.

Cut & Place first brings up a dialog for setting the scale. The Horizontal Scale and Vertical Scale are used to determine the vertical exaggeration of the cross-section view. The Cut Swell Factor will be applied to any new cut areas. The Cut Volume Swell Factor is multiplied by the cut area to determine the fill area of the spoil pile. The Top Spoil Width is the flat width at the peak of the spoil pile in feet or meters. The Highwall Angle is used with the Define Cut Area By Points option as the angle from the picked points at the bottom of the cut area up to the surface. There are both left and right windows. The Repose Angle is the angle of the spoil pile. This can vary, as shown later in an extended bench example. All four of the Angles should be entered in as degrees. The Label Areas option will draw text for the cut and fill amounts, prompting you to pick the text locations. Prompt for Snap activates a snap dialog box during the picking phase of the routine. Track Undisturbed Ground Polyline should be turned on to track rehandle, to make sure it is not swollen more than once, and for reporting rehandle quantities. The Sequence Number window is for entering in the step number for the sequence file if the Store Step to Sequence File is being written. The Spoil Placement Method allows for selecting the position of the Left Toe, Right Toe, or the Top of Pile. These locations will be constant when processing the sequence. The Define Cut Area is either by Points, where you select the lower left, then the lower right cut points, or by a pre-drawn closed polyline representing the cut block.
The Store Step to Sequence File will write out a SEQ file for later processing with Process Dragline Sequence. This file should be set to New for step number 1, then set Append/Revise for any further steps from 2 or more. This method will take the one range diagram template and apply it to the entire pit along a centerline. The Store Step to Report File is used if the user is running cut and place on multiple cross-sections. The file should be new for the first Station, then set to Append/Revise for additional stations. These are processed with the Dragline Section Report commands.

When picking points, there is an option to select a strata polyline which will be used as the bottom cutoff for the cut area. Also while picking the points, there is a real-time window that shows the point offset, slope and distance as you move the cursor. Once the point is picked a snap dialog allows you to adjust the picked point. For example, you could use the real-time window to visually pick the right cut point. The actual picked right position could be 201.32 from the left point and then you can the snap dialog to round the position to 200. This adjust point dialog only appears if the Prompt for Snap option is on. You can also specify a reference point by typing ‘R’ for the Reference option at the command prompt. This option will prompt you to pick a reference point in the section. For example you could choose the toe of the existing highwall as the reference point and make the right cut point offset by 10.0.

After choosing the cut area, the spoil pile is placed by picking a point to place the spoil. This point can be either the left toe of slope, right toe of slope or top of pile. After defining the cut and spoil, there is an option to go back
and adjust the cut or spoil points. Select L, R or S for left point, right point or spoil location. Adjusting the cut points will automatically resize the spoil pile-watch it dynamically change. Once everything is set, press Enter to end the routine. The surface profile polyline is redrawn with the cut area removed and the spoil added. The changed segments of the original surface are drawn a different color, usually gray.

The user input for this command can be saved to a sequence file (.SEQ) for the Process Dragline command or a section report file (.CUT) for the Dragline Section Report command. With the sequence file active, the program will prompt for a centerline reference point which is the point in the cross-section view that the centerline for Process Dragline passes through. It needs this point to locate the cross-section horizontally in the plan view relative to the centerline drawn in plan view. If you choose a strata polyline, the program will ask for the strata name of this polyline. The Process Dragline command will then prompt for a grid file that models this strata name. The data that is saved includes the depth and offset of the cut points, the spoil pile offset, and the slopes. Besides specifying the sequence file name to write to, the sequence number is also stored. This number orders the steps in Process Dragline. For the Dragline Section Report, the program will store the station, sequence number, and cut and fill areas.
The Track Undisturbed Ground Polyline option is for calculating rehandle. With this option on, the program will prompt for the existing ground polyline as usual plus an additional undisturbed ground polyline. The undisturbed polyline is the same as the existing ground polyline except that the undisturbed polyline does not have the spoil piles. One way to start this process is just copy the Surface line onto itself, then move one away from the other on one of the ends for ease of selecting for the first cut. After the first cut, it should be easy to select one or the other. Cut & Place will update the undisturbed polyline by removing the cut area and will not add the spoil pile. The program will also report any rehandle using the undisturbed polyline. The swell factor is not applied to the rehandle.

This command will also fill in for some of the Dozer Push shortcomings. If there is a simple extended bench needed, the set one of the spoil slopes to 0 and it will create a flat spoil for that step. Be sure to hit enter when prompted for the top of coal line. The next cut could be a pre-drawn, closed polyline or a series of cuts to remove the material. The lower right cut slope in the case could be the same as the spoil slope to create the left slope of the spoil.

**Prompts**
Cut & Place Settings Dialogs
Select existing ground polyline: pick a polyline
Pick centerline reference point on ground polyline: pick a point on ground polyline
Select strata polyline (Enter for none): pick the strata polyline
Enter strata name for strata polyline: UB_TOP
Reference/<Pick lower Left cut point>: pick a point
Reference/<Pick lower Right cut point>: pick a point
Right Cut Point dialog
Reference/<Pick spoil pile location>: pick a point
Control point to adjust (Left cut/Right cut/Spoil/<None>): press Enter
CUT: 2327.00 (sf) FILL: 2327.00 (sf)
Pulldown Menu Location: Surface
Keyboard Command: range1
Prerequisite: Surface polyline in profile view from a Profile or Fence Diagram. Grids of the seams if writing sequence file.

Cut Only (Coal Removal)
This command is similar to Cut & Place. Cut Only removes a cut area in cross-section view from a surface polyline. The difference with Cut & Place is that this command does not place the cut area as a spoil pile. The cut area is just removed from the surface polyline for operations like remove coal. Try to stay away from a 90 degree face on the coal, AutoCAD doesn't like vertical faces (89 is entered below). The Type of Cut chooses between Coal (Key Only) and Prestrip (Non-Key Only). This setting is used in reporting and doesn't effect the rest of the routine. The same prompting and snap dialogs appear here as in the Cut and Place command.
Prompts

Select existing grade polyline: pick the surface polyline
Pick centerline reference point on ground polyline: pick a point on the surface polyline
Select strata polyline (Enter for none): pick a strata polyline
Enter strata name for strata polyline: UB_BOT
Pick lower Left cut point: pick a point
Pick lower Right cut point: pick a point
Control point to adjust (Left cut/Right cut/<None>)? press Enter
CUT: 91.42 (sf)

Pulldown Menu Location: Surface
Keyboard Command: rmcoal
Prerequisite: Surface polyline in profile view

Flatten Spoil Top

This command takes a surface polyline drawn with a spoil pile and flattens the top of the spoil pile so that the horizontal distance across the top equals the user-specified distance. It will either push to the left, right or both directions. This step can be stored to a sequence file (.seq) for the Process Dragline Sequence command.
Chapter 16. Surface Mining Module

Before Flatten Spoil Top
Prompts

Select pile to flatten: *pick the surface polyline near the top of the spoil pile*

Pulldown Menu Location: Surface in the Mining Module

Keyboard Command: spoil

Prerequisite: Surface polyline in profile view with spoils

Cast Blast Profile

This command applies a blast profile to a cut area in cross-section view. Before starting this command, the surface should be drawn as a polyline from left to right.

Cast Blast first brings up a dialog where you can set the scale, highwall angle and swell factor. The Horizontal Scale and Vertical Scale are used to determine the vertical exaggeration of the cross-section view. The Highwall Angle is used with the Define Blast Area By Points option as the angle from the picked points at the bottom of the blast area up to the surface. The Cut Volume Swell Factor is multiplied by the cut area to determine the fill area of the spoil pile.

The area to cut can be either a closed polyline or defined by picking the lower left and lower right points. When picking points, there is an option to select a strata polyline which will be used as the bottom cutoff for the blast area. The blast profile can be defined by either a polyline drawn from left to right on the screen or by a Carlson profile (.pro) file. Refer to the Section & Profile module for how to create a profile file.
After placing the blast profile, there is an option to adjust the blast profile points. To adjust a point, pick on the blast profile near the point to modify. This will pick up that point and you can pick a new position. When a point is moved, the program will automatically fit the updated blast profile. Once everything is set, press Enter to end the routine. The surface profile polyline is redrawn with the blast area showing the blast profile. The changed segments of the original surface are drawn in a different color.

The program reports the cut and fill end areas and the cast to final percent which is the percent of the fill area that is in the final spoil area. The cast to final area is defined by the area past the line starting at the toe of cut and going up at the Repose Angle. This starting point can be offset from the toe of cut by using the Spoil Toe Offset field. A negative offset moves to the left and a positive to the right. The Auto Fit Cast To Final option will adjust the blast profile by moving the profile horizontally such that the placed profile balances the cut and fill areas and meets the specified Target Cast to Final percent.
There is an option to save the user input for this command to a sequence file (.seq) for the Process Dragline command and to a section report file (.cut) from the Dragline Section Report command. With the sequence file active, the program will prompt for a centerline reference point which is the point in the cross-section view that the centerline for Process Dragline passes through. If you choose a strata polyline, the program will ask for the strata name of this polyline. The Process Dragline command then prompts for a grid file that models this strata name. Besides specifying the sequence file name to write to, the sequence number is also stored. This number orders the steps in Process Dragline.

**Prompts**

Select existing grade polyline: *pick a polyline*
Pick centerline reference point on ground polyline: *pick a point on the ground polyline*
Select strata polyline (Enter for none): *pick a polyline*
Enter strata name for strata polyline: UB_TOP
Pick lower Left cut point: *pick a point*
Pick lower Right cut point: *pick a point*
Select blast profile polyline: *pick the polyline representing the typical profile*
Cast to Final: 10.20%
Pick profile point to modify (Enter to end): *pick a point on the blast polyline*
Pick new position: *pick a point for the new position*
Pick profile point to modify (Enter to end): press Enter to end

CUT: 1775.60 (sf) FILL: 2308.28 (sf)

Pulldown Menu Location: Surface
Keyboard Command: spoil
Prerequisite: Surface polyline in profile view

---

**Polyline to Centerline File**

This command is described in the Centerlines section of the manual. Please refer to it there.

**Area To Section Report**

This command stores the area of closed polylines into a section report file (.cut) that is used by the Dragline Section Report command. Along with the area of cut and fill, this command associates a station and sequence number. The station is the distance along the dragline centerline and the sequence number orders the area in the steps at that station. There can be several steps at each station. This command prompts to select a cut area polyline which should be a closed polyline in section view. There is also an option to select a fill polyline. The areas can be assigned a description that is used in the Dragline Section Report.

![Area To Section Report](image)

---

**Prompts**
Select cut area polyline: *pick a closed polyline*
Cut Area: 17929.86
Select fill area polyline (Enter for None): *pick a closed polyline*
Fill Area: 22184.69

Description <Cut Area>: *Shovel Pass1*

Pulldown Menu Location: Surface
Keyboard Command: cutarearprt
Prerequisite: A closed polyline in section view

Dragline Section Report

This command reports the end areas at different stations based on the accumulated stored results of various dragline routines. The report data is read from a section report file (.CUT). The commands that can add to the section report include Cut & Place, Cut Only, Dozer Push, Cast Blast Profile and Area to Section Report.

The report formatter is used to create the section report. This formatter allows you to choose the fields to report and the report layout. The report can also be output to Excel or Access.
Pulldown Menu Location: Surface
Keyboard Command: cutreport
Prerequisite: A section report file (.cut)

**Process Dragline Sequence**

This command applies 2D cross-section dragline steps along a centerline to create a 3D model. The dragline steps are stored in a sequence file (.SEQ file) that can be created by the Cut & Place, Cut Only, Dozer Push, Flatten Spoil Top and Blast Cast commands.

There are two different methods for Process Dragline Sequence. The Multiple Along Centerline method applies the dragline sequence along a centerline for a range of stations. The centerline defines the dragline alignment and the mining surfaces are defined by grid files and/or section files. This method outputs section files, 3D polylines and a volume report. The Single Section Polyline method applies the dragline sequence to one station in cross section view. The dragline position is defined by picking the centerline position in section view and entering the elevation at this point. The mining surfaces are defined by picking polylines for the ground surface and strata in section view. The output is drawn as polylines in section view for this one station.

Each of the steps has a centerline reference point and the control points for the step are relative to this reference point. For example, the top of the spoil pile for Cut & Place could be 75 feet right of the centerline. Process Dragline Sequence runs the steps along the centerline. A centerline file (.CL file) can be created from a polyline with the Polyline to Centerline command.
The existing ground can be modeled by either a grid file (.GRD file) or section file (.SCT file). Process Dragline Sequence works by repeating the 2D cross-section steps for each section along the centerline. When using a grid file surface, the program will prompt for a station interval and will create ground cross-sections at the specified offset left and right of the centerline at this interval before applying the dragline steps. When using a section file surface, the program will apply the dragline steps at the interval of the section file. There is an option to output the results of dragline steps to a section file. Besides outputting the final section results, sections at the end of each step can be saved to section files. The section files of each step are named automatically by adding the step sequence number to the original final section name.

The dragline steps have an option to use a strata polyline which makes the control points relative to the strata. If strata polylines are used, then the Process Dragline will prompt for a grid file that models the strata. For example, you could use a top of coal polyline in the Cut & Place command to define the bottom of the cut area. With the store sequence file (.SEQ) option on, the program will prompt for a name for the polyline and you could enter "coal". This name is stored in the sequence file and when Process Dragline Sequence is run, the program will prompt for you to select the "coal" grid file.

The program creates a report of the volumes for each step in the sequence. The Coal Density field in the dialog is used for calculating the coal tons for the report. The Taper Spoil Sides option adds stations before the first cut and after the last cut to show the repose angle of the ends of the fill spoil piles. There are options to draw 3D polylines of the pits. Draw Pit Polylines creates 3D polylines parallel to the centerline along the dragline control points such as the top of the spoil pile. Draw Cross Section Polylines creates 3D polylines perpendicular to the centerline for each cross section.
Prompts

Process Dragline Sequence dialog
Station interval <100.0>: press Enter
Processing step> 1
Processing step> 2
Drawing offset 3D polylines: STEP1-SPOIL3
Drawing cross section 3D polylines
Writing section file> D:\SC14\DATA\final.sct

Pulldown Menu Location: Surface in Advance Mining
Keyboard Command: steps
Prerequisite: Centerline file, Sequence file and surface grid file
**Design Dragline Pit**

This command designs a pit into the existing ground surface using a set of dragline and bench slopes. The dragline slopes are for the portion of the pit excavated by the dragline and the bench slopes represent the truck-shovel excavation. The pit is drawn with 3D polylines and the pit volumes for the dragline and truck-shovel are calculated.

Before running this command, the base of the pit should be drawn as a closed 3D polyline. This pit polyline should also be assigned the elevations for the bottom of the pit. One way to set the elevation is to create a grid file for the bottom of the pit. For example, use Make Strata Grid Files to make a grid of the top of coal elevation. Then use the command 2D to 3D Polyline by Surface Model to convert the pit polyline into a 3D pit polyline with the grid elevations. This 2D to 3D command usually creates more vertices then necessary for Design Dragline Pit. So it is good to run Reduce Polyline Vertices.

Design Dragline Pit starts with the dialog shown below. All slopes are entered as percent. There is an option for two dragline slopes to allow for different slopes in different material, though it will be reported as one volume. The break point between these slopes can be set as either depth or at a grid surface. The grid surface could be a grid file for the transition strata. Next there is a dragline bench width and slope followed by cut and bench slopes. The cut-bench slopes repeat until intersecting the surface. The resulting modified surface can be saved as a grid file (.grd) with the Write Output Grid File option.

![Dragline Pit Parameters](image)

The program works by starting from the base pit polyline and applying the slopes until the surface is reached. The surface is modeled either by a grid file or from the entities on the screen. With the screen option, all 3D entities in the pit area are used to model the existing surface.

If a pit already exists to one side of the current pit, then this existing pit should be part of the surface model. Then the program will intersect the surface right away on this side without creating all the dragline and bench slopes. The Write Output Grid File allows you to save a grid file at the end of the command that represents the surface updated with the new pit. Then you can run Design Dragline Pit for the next pit and use the grid file output from the previous time as the new surface model.

The volume report shows the dragline cut and the truck-shovel cut. The dragline cut includes the volume from the pit base up to the top of Dragline Slope 2. The truck-shovel cut is the remaining volume up to the surface.
Plan view of dragline pit polylines
Profile view of dragline pit slopes

**Pulldown Menu Location:** Surface  
**Keyboard Command:** minepit

---

**Design Bench Pit**

This command creates pits where the sides are a series of slopes with benches. The side slopes start from a closed polyline. This pit polyline can be either the bottom of the pit and the slopes run up and out to intersect the ground surface, or the pit polyline can represent the top of the pit and the slopes run down and in, to intersect the pit bottom grid. Different slopes can be used for different sides of the pit. The pit is drawn as 3D polylines and the pit volumes are reported.

Before starting this command, the pit perimeter should be drawn as a closed polyline, 2D at zero elevation, or at 3D elevations on a surface. The program also needs triangulation or grid files for the existing ground surface and the bottom of pit surface. Design Bench Pit starts with the dialog shown below to specify these grid file names.
• **Ground Surface:** This is the surface to start the pit at.

• **Pit Bottom:** This is the surface that will represent the bottom of the pit.

• **Write Surface History File:** This output file is a GSQ file that is used for volumes in Surface Mine Reserves which leads up to surface mine timing and scheduling on these volumes, or for 3D Viewing as a movie with View Surface History File command.

• **Round Exterior Corners:** This option will create rounded corners on the outside edges of the pit for a more realistic design. When this is off, the corners are sharp and angular.

• **Write Output Grid File:** This option will create a grid file (GRD) of the design. It includes the original ground surface grid file, with the pits built onto it.

• **Use Elevations From Pit 3D Polyline:** This will use the elevations on the polyline as the start of the design. It will start the pits at the elevations the polylines are drawn at instead of starting at the Pit Bottom Grid for going up, or the topography when going down.

• **Force Bench with Width and Max Depth:**

• **Process Multiple Polylines by Pit Names:** This option is to process multiple pit perimeter polylines all at once. The pit polylines must have pit/site names assigned and the program will process them in the order of their pit names. As each pit polyline is processed, the ground surface is updated with the pit volume removed. Then the next pit will use this updated ground surface. When Process Multiple is active, the **Sequence Method** choose the way to order the pits for processing. The **Pit Name** method processes the pits in alphabetical order. The **Timing File** method uses the pit assignment order from Surface Equipment Timing from the .TIM file.

• **Separate Layers by Pit Names:** This option puts the 3D polyline break lines of each pit on their own separate layer. It takes the Pit Layer, and increments them by -2, -3 etc.

• **Create Road:** This option carves a rough road into the pit design. In the dialog, the road **Direction**, **Road Width** and **Road Slope** % are specified along with a color for the road polylines to create. When this option is active, the program will prompt for a road starting point along the pit perimeter. The cut slopes are shifted
to make room for the road.

- **Slope Direction:** Up will start at the pit bottom and bench up and out to the surface topography. Down will start at the top surface, and bench down and in to the pit bottom.

- **Slope Method:** Projection is a method that projects the 3D polylines down the slope, across the benches. Offset is a method that offsets the horizontal "toe and crest" lines to create the pit shells this way. Both methods will have horizontal and vertical breaklines, but the method they are generated is different. Each method has its benefits and might work better than the other for each unique scenario. If there is a problem with one method, try the other to see if it handles it better.

- **Horizontal & Vertical Interval:** These settings control the distance to draw the 3D breakline polylines. The horizontal interval will run down the slope, and across the bench. The vertical interval will run parallel with the benches. It should be a factor of the bench height if possible, but not required.

- **Min Bench Height:** The bench is not created when the side slope depth is less than the specified amount.

- **Side Layer:** This is the layer of the 3D polylines drawn perpendicular to the benches, and running down slope.

- **Pit Layer:** This layer is applied to the 3D polyline break lines running parallel to the benches.

- **Use Bench Name for Layer Suffix:** This option adds the bench name to the Pit Layer so that each bench can have a unique name which can be useful for having different colors for each bench for visualization or for isolating benches by layer.

- **Draw Side Slope Polylines:** This option chooses whether to draw the 3D polylines running perpendicular to the benches, and down slope.

- **Bench Color:** This puts the bench 3D polylines in the Pit Layer on a different, specified color so they stand out against the slope breaklines.
The next dialog defines the cut and bench slopes. Cut slopes are entered as ratios. The cut depth can be either a fixed depth number or to a grid file. For a grid file, the program will find the intersection of the cut slope with the grid surface and will end the cut slope at this intersection. For example, you could make a grid file for a second coal seam and have the bench occur at this coal seam. After the cut slope, the bench slope and width are used. The cut and bench slopes are applied in order until there is an intersection with the surface. Once you have all the cut slopes defined, you can use the Save button to save these slope settings to a .PIT file. Then these settings can be recalled later with the Load button.

Four different sets of slope schemes can be defined. To define the another slope scheme, select other Slope Group tab. The set of slopes that you are currently editing is indicated by the selected tab. If you define different sets of slopes, then the program will prompt you to pick which sides to apply each set of slopes to. All sides are assumed to be slope type one. So you only have to identify types two, three and/or four. If only one slope group is defined, then you will not be prompted to select any additional sides.

If a pit already exists to one side of the current pit, then this existing pit should be part of the Ground Surface grid file. Then the program will intersect the surface right away on this side without creating all the bench-cut slopes.

Here are a couple of examples of the various settings in Design Bench Pit.

- Offset Method:

- Offset Method with Road in red:
Projection Method:

- Multiple Pits with Offset Method and Viewing the Grid History File in 3D.
Prompts

Pick the pit polyline: pick the closed polyline
Pick pit polyline segment for side 2 slopes (Enter to continue): pick the segment near midway, it will highlight
Pick pit polyline segment for side 2 slopes (Enter to continue): pick the segment near midway, it will highlight
Pick pit polyline segment for side 2 slopes (Enter to continue): press Enter to continue

Pulldown Menu Location: Surface in Surface Mining Module
Keyboard Command: minepit2

Design Spoil Pile

This command creates a spoil pile at a target volume or elevation. There are a few design methods. The Perimeter Polyline method takes a 3D polyline outline of the top of a spoil pile and adjusts this polyline by either changing the elevation or extending a side to reach a specified volume for the pile. The resulting pile is drawn as 3D polylines showing the side slopes and where the pile ties into the existing surface. The Cone methods take a single point and slope to build a spoil cone. The cone can be sized by either target volume or by height.

For the Perimeter Polyline method, you can choose between Extend Bench and Adjust Elevation. The extend bench option will prompt for a side of the pile to offset. Holding all the other sides with their elevations, the program will offset the selected side until the target volume is reached. For the adjust elevation, the entire pile polyline is moved up or down to obtain the target volume. Before starting this command in Perimeter Polyline mode, you need to draw a closed 3D polyline that represents the top of the pile. The fill slopes will start at this polyline and will run out and down until the slopes intersect the surface model.

![Spoil Parameters dialog box](image)

The Fill Slope can be specified in ratio, percent or degree format. The Pile Layer is for the 3D polylines that this command creates for the spoil. The Write Output Grid File option creates a .grd file of the spoil surface.

As the program runs, it will seem to draw several piles as it tries to find the target volume. The resulting volume will not match exactly the target volume but will be very close. The smaller the grid cell size, the closer it will be. This difference is just to save processing time.
Spoil Pile by Cone method
**Pulldown Menu Location:** Surface  
**Keyboard Command:** spoil2

**Design Fill Surface**

This command creates fill pile where the sides are a series of slopes with benches. The side slopes start from a closed polyline. The perimeter polyline is the toe of the pile, and the slopes will be up and in from the footprint of the pile. Different slopes can be used for different sides of the fill. The fill is drawn as 3D polylines and the fill volumes are reported.

Before starting this command, the perimeter should be drawn as a closed polyline, 2D at zero elevation, or at 3D elevations draped onto a surface. You also need a grid file for the existing ground surface. Design Fill starts with the dialog shown below where you specify the grid file name.

- **Ground Surface:** This is the surface to place the fill pile on. The **Write Output Grid File** allows you to save a grid file at the end of the command that represents the surface updated with the new pit. Then you can run Design Bench Pit for the next pit and use the grid file output from the previous time as the new Ground Surface. The **Round Exterior Corners** option holds the slopes around the corners which makes the benches curve around the corners. Otherwise the side benches stay straight until they meet benches coming from other sides at the corners.
- **Use Elevations From Perimeter 3D Polyline:** This will use the elevations on the polyline as the toe of the fill pile to start the design.
- **Write Output Grid File:** This option will create a grid file (GRD) of the fill. It includes the original ground
surface grid file, with the fill pile built onto it.

- **Round Exterior Corners:** This option will create rounded corners on the outside edges of the pile for a more realistic design. When this is off, the corners are sharp and angular.

- **Horizontal & Vertical Interval:** These settings control the distance to draw the 3D breakline polylines. The horizontal interval will run down the slope, and across the bench. The vertical interval will run parallel with the benches. It should be a factor of the bench height if possible, but not required.

- **Side Layer:** This is the layer of the 3D polylines drawn perpendicular to the benches, and running down slope.

- **Pile Layer:** This layer is applied to the 3D polyline break lines running parallel to the benches.

- **Draw Side Slope Polylines:** This option chooses whether to draw the 3D polylines running perpendicular to the benches, and down slope.

- **Bench Color:** This puts the bench 3D polylines in the Pile Layer on a different, specified color so they stand out against the slope breaklines.

**Fill Slope Format:** The slope angle can be defined in percent, ratio or degrees. This is what is entered in the Fill Slope.

- **Slope Group:** Four different sets of slope schemes can be defined. To define the another slope scheme, select other Slope Group tab. The set of slopes are currently being edited is indicated by the selected tab. If different sets of slopes are defined, then the program will prompt to pick which sides to apply each set of slopes to. All sides are assumed to be slope type one. it is only necessary to select types two, three and/or four. If only one slope group is defined, then it will not prompt to select any additional sides.

- **Fill Slope:** The slope angle can be defined in percent, ratio or degrees. This is what is entered in the Fill Slope.

- **Fill Target:** The target to fill to for each bench can be a flat elevation, a depth above the previous surface or bench, or up to a grid file surface.
• **Depth:** The Depth must be filled in when the target is set to depth.

• **Elevation:** The Elevation must be filled in when the target is set to elevation.
• **Select File:** The file must be selected when the target is set to file.
• **Bench Slope %:** This setting will slope the benches down for drainage if desired. Normal setting for flat bench is 0.

• **Bench Width:** This is the horizontal width for the bench in feet or meters.

• **Bench Name:** This is used for pit design to name the benches for volumes. It does not have much application in the Fill version of this command.

• **Delete:** This deletes one line of data.

• **Insert:** This inserts a blank row to be filled in.
• **Clear:** This clears the entire slope group page, only the current group.

• **Load:** This loads a previously saved PIT file with the template saved.

• **Save:** This saves the template as shown in the window.

• **Preview:** This displays a preview of the current group to show how the cross section of the fill will look.

Shown here is a sample fill design in both plan view and 3D.

The report window appears at the end of the command to display the volume of the fill in CY or CM.
Prompts

Pick pile perimeter polyline: Pick the perimeter
Preparing bench grids ...
Calculating bench pit ...
BENCH1
Processing edge 2424, intersections found 1382
Calculating grid elevations ...
Writing grid file: C:\Carlson Projects\2009 User Conference\Mine Reserves\Fill Surface.grd
Processing cell ...
Command:

Pulldown Menu Location: Surface in Surface Mining Module
Keyboard Command: spoil3

Define Fill/Cut Design

This routine defines the template for the fill or cut sequence of designed pit or fill. Slope, colors, surfaces and boundaries are specified and saved for processing. This is the first step to designing the cut or fill. After this template is defined, then the 3D design is created with the command Process Fill/Cut.
The first window has a File menu dropdown and several options for settings:

**Load:** This loads a previously saved template file. They have the *.RMP extension.

**Save:** This saves the currently defined Fill/Cut template to a *.RMP file.

**Clear:** Choosing Clear will clear all entries in the template. Use this command if the program is producing errors while running and start over. Sometimes remnants of other templates are still being used, and it is best to start over instead of trying to replace the templates.

**Set Snap:** This option determines the level of acceptable rounding of calculated points. Larger snaps reduce excess points, but may collapse the geometry. The default is 0.01 drawing units.

**Colors:** Selecting the Colors button brings up the Colors dialog box. Here you choose a color for the breaklines created for the Road, Slope and Bench.
**Cut or Fill:** This is the determining setting if the program will cut down or fill up from the boundary.

**Horizontal Resolution:** This is the setting for how often a horizontal breakline will be drawn. Breaklines will be drawn closer in corners and intersections, but never larger than this resolution. These are the breaklines that run from the top to the bottom of the slope.

**Vertical Resolution:** This is the setting for how often a vertical breakline will be drawn. These are the breaklines that run around the disturbance area, parallel with the benches. It works well if the vertical resolution is less than the bench height, putting a breakline in between the slopes. It is best if the interval is a factor of the bench height, i.e. 50' benches and 25' vertical resolution. Here a bench is defined as a flat or nearly flat section in the template between two sloping surfaces.

**Force Road Method:** There are two methods by which the stepping is done. A simple method, and the more complex method that is used by the Road option. If you have a very complex boundary that the regular, simple method does not handle well, use this option. It does not place a road unless that is turned on in the next screen. It just uses the road algorithm. There is no reason to use this method for simple cuts or fills. If they look fine, then leave this off. It will run much slower with this option turned on, so leave it off unless you need some more intelligence. If you have a fill with more than one peak, then you will need to leave the Force Road Method off, as it uses the road logic, and draws a road only to the first peak created.

**Boundary:** Selecting this button leads to the Boundary Line dialog box for specifying the perimeter line and the surface or elevations of the line.

**Boundary Line Definitions**
**Select in AutoCAD:** This option will take you to AutoCAD with the pick box active, ready to select the polyline for the perimeter. Sometimes the dialog disappears and you need to select it from down in the Windows bar.

**Read PLN File:** This will prompt for a *.PLN file to use as the perimeter. The PLN file is created with other Carlson routines.

**Min(imum) Line Length:** This setting will break the segments of the polyline into sections of at least this many units (feet or meters) in addition to the actual vertices on the polyline. This is needed for the Select Points for This Template command seen below.

**Same As Last Run:** Selecting this option brings up the perimeter that was used last run. The large preview window displays the perimeter line that will be used, so it is easy to verify.

**Use Values On Boundary Line:** If the selected polyline is 3D, then it will use the elevations of the polyline.

**Model By Triangulation (FLT) File:** Selecting this option will prompt for the FLT file to use for the polyline elevations.

**Model By Grid (GRD) File:** Selecting this option will prompt for the GRD file to use for the polyline elevations. It draws the grid in the background of the preview window as cyan colored cells.

**Use Elevation:** Selecting this option will prompt for the elevation to use for the perimeter. It will be a flat line at this elevation.

**Previous:** Selecting this button takes you back to the main layout screen.

**Process And Continue:** Once the perimeter and source of elevations are chosen, you select Process And Continue to define the templates. This takes you to the next window.

**Slope Design Templates**
This Slope Extends to Elevation: Selecting one of the five options here determines what the slope will go to.

**Elevation:** The fill or the cut will go to this elevation.

**Grid:** The fill or the cut will go to the selected grid file (*.GRD).

**TIN:** The fill or the cut will go to the selected TIN file (*.FLT).

**Min Area:** The fill or the cut will go to an elevation where the area of the top or bottom will not go below this value in square feet or meters.

**Ultimate Slope:** The fill or cut will continue until the maximum height or depth is attained. This gives a peak in a fill or a V shaped pit bottom.

**Next Slope:** Selecting this option will take you to the next slope group. This is shown by the "1 of 1" text in the upper right corner.

**Delete Slope:** Selecting this option deletes the current slope group.

**Add Slope:** Selecting this option adds a new slope group. The templates will be applied to each slope group separately. For example, one set of templates can cut down at a 1:1 to a certain elevation or file-top or rock for example. The next slope group can continue down at a 0.5:1 slope to the bottom.

**Zoom Functions:** There are 6 zoom functions for changing the view in the preview window: Zoom Out, Zoom In, Zoom Previous, Zoom Extents, Zoom Window and Pan.

**Done:** After everything is defined, this option goes back to the previous screen.

**Road On:** Selecting this option will use the road building algorithm and build a road with the entered parameters.

**Width:** Specify a total road width in feet or meters.

**Slope %:** Enter the road slope in percent, i.e., 12.

**Clockwise:** Choosing this makes the road wind clockwise, leaving it blank creates the road winding counterclockwise.

**Select Start Section:** You must select where to begin the road on the preview of the perimeter. The selection must cross the perimeter line as shown above with the short black line on the far right of the perimeter line. Just pick the two points, one on either side of the perimeter, with two left mouse clicks.
**Show Profile:** This option brings up a profile of the ramp, to make sure it does not cross the existing ground perimeter polyline. If it does, it will give an error message as shown below, and the problem area is shown below the two red lines. To fix this, either pick a new ramp starting location, or modify the elevations of the perimeter.

![Ramp Profile Error Message](image)

To fix this problem, the road starting location was moved to the north, and now the road slope line does not cross the boundary profile line.
**Bench Transition Length:** This is the distance the road goes flat across the bench, until it starts up or down again.

**Taper to Bench Inside:** This is the other option if there is not a Bench Transition Length desired. This will "hug" the inside of the bench until the road gets across it.

**Template Design**

**Hold Elevation or Hold Distance:** When making changes in the template, one of the first two columns must remain fixed, either the elevation or the horizontal distance. You select which one will stay, while the other changes if you modify the slope or any other parameter.

**Template Base Elevation:** Enter in a starting elevation if the bench interval desired is above or below what the program is calculating. Normally, benches are created at logical increments of the template, such as 1050, 1100, 1150, etc. If you want benches at 1055, 1105, 1155, etc, then you would enter 5 in the base elevation for example. This value will basically offset your benches up or down this amount.

**Delta Distance, Delta Elevation, H-V Ratio, Slope %, Slope Degrees:** This is the section to enter in the slope and benches. The first five columns may be used, other variables will be calculated if another is modified. The last
two, Total Distance and Total Elevation are locked, and cannot be used. For flat benches, just enter a Delta Distance, with 0 as the Delta Elevation. A preview of the slope group will appear in the preview box. If it does not show up for some reason, you may need to save the RMP file, close the program and restart it. This will reset the template preview window.

**Bench Taper Length:** Enter in the distance for a bench to taper from zero width to the full width.

**Variable Bench Design:** This option will keep the same bench/slope ratio while the bench widens to its full thickness. If the template has a 45 degree slope, 50' high, and a 50' bench, then as the slope increases its height, the bench width will increase at the same ratio/rate. If the bench height to width is always 5:1, then that ratio will always be produced in the widening of the bench.

**Next Template:** Selecting this button brings up the next template defined. If there is only one, the bottom of the window is red, and nothing happens. If you have other templates defined (with the Add Template), then it will scroll through them. Each will have a distinct color to show where they correlate to the perimeter in the preview window. The colors of the template design window and the corresponding line segments of the perimeter are in this order: red, green, cyan, orange, blue, magenta, light green and black.

**Add Template:** This will add a new, empty template to the design. Each new template added will have its own, unique color to keep them organized. The colors are listed just above.

**Select Points For This Template:** After a template is defined, this option defines where on the perimeter, the program will apply this set of slopes and benches. You must pick a starting point and run clockwise to pick the last point. The perimeter line will change color to match the template color. This lets you know where each template is defined. If there is only one template (the initial red one), then the entire perimeter line is red to match it.

**Pulldown Menu Location:** Ore
**Keyboard Command:** rampdesign

**Prerequisite:** A boundary perimeter and a surface. These could either be selected on screen in AutoCAD or saved as files.

---

**Process Fill/Cut Design**

This routine is simply the execution of the Define Fill/Cut. It creates the 3D design of the fill or cut. Some examples are shown below. The process window shows the elevation it is on and the percent done. The benches can be seen drawing in realtime as it calculates each one.
Valley Fill Example

Stockpile with Ramp Example
Benched Pit with Ramp Example

Prompts

No prompting. It processes the current RMP file.

**Pulldown Menu Location:** Ore
**Keyboard Command:** ramp
**Prerequisite:** Need to have run Define Fill/Cut and created a template

Vertical Pit Quantities

This command calculates overburden and strata quantities. The strata thicknesses are defined in coal sections or drillholes. This routine requires a 3D closed polyline with elevations of the top of the seam. This polyline is also used as the perimeter of the pit. The routine calculates a surface model for the top of seam using this 3D polyline. Then a surface model for the ground surface is calculated from the selected surface entities such as points, lines or polylines with elevation (contour polylines). The overburden volume is calculated as the volume between these two surfaces within the 3D polyline. Each strata is modeled and the volume calculated for the area within the 3D polyline.

Prompts

**Coal Section Configuration File**
Select the file that defines the coal section sample points.

**Pick top of coal polyline:** *pick the closed polyline*
Choose the .grd file to update.

**Select surface entities and at least 3 coal sections or drillholes.**
**Select objects:** *pick the entities*

**Make Grid File dialog** Choose a grid resolution

**Beginning date of takeup [format mm-dd-yy]:** 6-1-92

**Ending date of takeup [format mm-dd-yy]:** 6-30-92

These dates used by Report Tons & Acres.

**Ownership/description:** Jones

This is the name of the data file to be updated for Report Tons & Acres.

**Coal recovery percent <100.0>:** 95

**Write column report file (Yes/No)?** press Enter This option creates a file minearea.dat in the data directory with the calculated quantities and other information in a column format.
Input for Vertical Pit Quantities: coal sections, 3D top of coal perimeter polyline, surface entities (contour polylines)

VERTICAL PIT WITH GRID METHOD
Individual Stratas Configuration
MINE: Watertown MINED FROM TO
AREA NO. 1 DESCRIPTION: .
AREA MINED (S.F.): 29686.84 DEPLETED ACRES: 0.682
VOLUME Coal: 147959.43 (S.F.), 5479.98 (C.Y.)
AVERAGE Coal THICKNESS (INCHES): 59.81 (FEET): 4.98
VOLUME Rock: 6785.11 (S.F.), 251.30 (C.Y.)
AVERAGE Rock THICKNESS (INCHES): 2.74 (FEET): 0.23
TOTAL MINING HEIGHT (INCHES): 62.55 (FEET): 5.21
AVERAGE Coal WT. (LBS/CU. FT.): 80.00
AVERAGE Rock WT. (LBS/CU. FT.): 120.00
Coal (TONS): 5918.38
Rock (TONS): 407.11
NON-RECOVERABLE COAL (TONS): 0.00 COAL RECOVERY PERCENT: 100.00%
TOTAL TONS: 6325.48 PERCENT COAL BY WGT.: 93.56%
VOLUME OVERBURDEN: 541529.65 (S.F.), 20056.65 (C.Y.)
STRIP RATIO: 3.39

Pulldown Menu Location: Surface
Keyboard Command: vertvol
**Update Grid File**

This command recalculates the surface model in a .grd file by using additional point data along with the original point data. Only .grd files created by the Make Drillhole Grid File command, in StrataCalc, can be used by Update Grid File. Make Drillhole Grid file stores a point file of the original data used to calculate the grid in a file with the same name as the grid file plus the extension .pnt. For example Make Drillhole Grid File will create stratax.grd and stratax.pnt.

The new point data for recalculation can be specified by picking points, entering point numbers that reference stored points in the current coordinate file, or selecting coal sections (from Place Coal Sections). When updating from coal sections, the program will prompt for a grid file that models the top of the coal sections. Since coal sections have thickness values but no Z values, this top of section grid is used to set the coal sections in the real Z axis. The program then updates the grid files that model each of the bottom elevation surfaces of the strata in the coal sections.

The updated grid can be saved in a new .grd file name or overwrite the original grid file by specifying the same file name. The location and resolution of the grid cannot be updated. So the original location and resolution should be made large enough to include any new area of point data to be added by Update Grid File.

**Prompts**

**Update grid from points or coal sections (Points<Sections>)? Points**

Grid File to Update file selection dialog
Choose the .grd file to update.

**Pick point or point number: 35**

**Pick point or point number: press Enter**

Choose modeling method (Triangulation/<Inverse distance/Kriging)? press Enter

Specify Grid File to Make
The updated grid will be stored in this .grd file.

**Pulldown Menu Location:** Surface

**Keyboard Command:** grdupdate

**Prerequisite:** Grid file created by Make Drillhole Grid File

**Tag Slope Groups**

This command places special symbols on pit polylines to indicate different slope groups to use in Design Bench Pit. The Design Bench Pit command supports up to four separate sets of cut slope definitions to be used on different sides of the pit polyline. Using the symbols from Tag Slope Groups is a way to batch process many pit polylines with separate slope groups. When Design Bench Pit finds symbols from Tag Slope Groups, the program skips the prompting to specify and slope group sides and uses the assignments from the symbols. For each edge in the pit polyline, the program looks for a slope group symbol. If a symbol is not found on a segment, then slope group #1 is used. So only symbols only need to be placed for slope groups 2-4.
The options dialog defines the symbol from the Symbol Library to use for each slope group as well as the symbol size, layer and color. There are a few methods for placing the symbols. The Pick Individually method prompts to a pick point on the pit segment and the symbols are added one pick at a time. The Crossing Line method prompts for two points and places a symbol at each pit polyline intersection along the line between the two points. The Window Area method prompts for a series of points to define the perimeter of an area and a symbol is drawn on the midpoint of all pit segments within this area.

Pulldown Menu Location: Surface
Keyboard Command: tag_slope_groups
Prerequisite: Pit polylines

Dragline Pits
This command calculates the total volume cut from a pit and the volume of a strata cut from the pit. The program requires two closed 3D polylines that represent the top and bottom of the pit. The top surface for volume calculations is modeled by the top polyline and any points in the bottom polyline that are outside the top polyline. Likewise the bottom surface is modeled by the bottom polyline and any points in the top polyline that are outside the bottom polyline. The top and bottom polylines are used as inclusion area polylines to limit volumes to within these polylines.

The program also processes two grid files that define the top and bottom of a strata. This volume is calculated between these two grids. This volume is the amount of strata cut from the pit. The inclusion area for the strata volume is the bottom pit polyline. The program assumes that the strata is entirely above the bottom of the pit and below the top of the pit.

This example shows a pit that is advancing from left to right. The left side of this pit was the edge of the previous pit.
**Prompts**

Select closed polyline of pit Top: *pick a closed polyline*
Select closed polyline of pit Bottom: *pick a closed polyline*

Make Grid File Dialog Choose a grid resolution.
Select Top of Strata Grid Choose .grd file that models the top of the strata.
Select Bottom of Strata Grid Choose .grd file that models the bottom of the strata.

Enter density of strata (lbs/cf): 75

Top of pit area: 31390.12 S.F.
Bottom of pit area: 31390.12 S.F.
Total cut: 1199184.98 C.F., 44414.26 C.Y.
Other cut: 810572.37 C.F., 30021.20 C.Y.
Strata cut: 388612.60 C.F., 14393.06 C.Y.
Strata density: 75 (lbs/cf)
Tons of strata: 14572.97
Strip ratio (C.Y. other/Ton strata): 2.06

Pulldown Menu Location: Surface
Keyboard Command: dragpit

**Regrade Backfill**

This feature applies to the narrow valleys of Appalachia where the goal is to regrade an existing valley fill with benches and specific slopes. Before starting this command you must create grid files (.grd) that represent the existing surface without any fill and the surface with the existing backfill. These grid files can be created with the Make 3D Grid File routine of the Civil Design module.

Regrade Backfill also requires a pre-drawn alignment polyline which defines the shape of the face of the regrade. This polyline must be drawn below the existing backfill and it must be at least long enough to reach across the widest part of the regrade.

To run the routine, specify the two grid files, the alignment polyline, the direction up the valley, the slopes, and the bench dimensions. The program then draws in the regrade as 3D polylines and calculates the cut and fill. To balance the cut and fill, choose the *Adjust parameters and redesign* option.

**Prompts**

Select Existing Surface Grid File
Select Backfill Grid File

Pick existing backfill perimeter polyline: pick a closed polyline that represents the limits of the backfill disturbed area

Pick the regrade alignment polyline: pick a polyline

Pick direction up regrade: pick a point towards the back end of the valley

Enter the vertical lift between benches <50.0>: press Enter

Enter the slope ratio (x:1) <2.0>: press Enter

Enter the bench width <20.0>: press Enter

Enter the bench percent slope <2.0>: press Enter

Enter the top percent slope <2.0>: press Enter This slope is used after the regrade reaches the top of the existing backfill until the end of the regrade.

Example Regrade Backfill Report:

Regrade Backfill Report

Vertical lift between benches: 50.00
Slope percent: 50.00%, slope ratio: 2.00:1
Bench width: 15.00
Bench slope percent: 2.00 slope ratio: 50.00:1
Top slope percent: 2.00 slope ratio: 50.00:1
Total fill: 13105.186 C.Y., 353840.01687 C.F.
Total cut: 13288.257 C.Y., 358782.93357 C.F.

Existing backfill and existing contours
3D view of regrade backfill. Also showing existing contours.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** backfill  
**Prerequisite:** Grid files of the existing surface and existing backfill and an alignment polyline.

## Blast Pattern Layout

This command creates a pattern of points in rows and columns using surface and shot bottom grids and dip direction. The options for this command are set in the dialog. Grid files for the ground surface and drill bottom are required. The Number By Row/Column option will number the holes by the hole row and column. Otherwise the holes are simply numbered sequentially. Up to four descriptions can be assigned to the holes such as pattern name, driller name, etc. The row and column distances can be specified separately. The drilling angle can be set in the Vertical Dip field which is entered as an angle where 0 degrees is straight down and 90 degrees is horizontal. The Dip Direction defines the horizontal orientation of the vertical dip. The row and column directions are entered as bearing angles. You need to figure these angles before running Blast Pattern Layout by using routines such as Inverse or Bearing & 3D Distance. The format is in dd.mmss where the degrees.minutes.seconds are separated by a decimal.

This command can generate a report using the report formatter that lets you choose the fields for the report and the fields layout. The report formatter can also output to Excel and Access. The points can be also be stored to the current coordinate file (.crd). The Preview button shows a preview of the pattern in the drawing so that if something isn't right, it can be adjusted before choosing OK. If the Create Points is turned on, then the points will be drawn in the blast perimeter.
After filling out the dialog, the program prompts for the blast boundary polyline which should be a closed polyline of the blast area. Finally you specify the starting point within this boundary polyline and the program calculates the points.
Prompts

Blast Pattern dialog

Select blast boundary polyline: pick a polyline
Pick starting point: pick a point
**Interval Along Entity**

This command is described in the Survey section of the manual. Please refer to it there.

**Blast Point Report**

This command projects points either from the blast bottom up to the surface at a dip direction or from the surface down to the blast bottom. These points are then reported using the report formatter that lets you customize the fields to report and the layout. Before running this command, you need the ground surface grid file, the blast bottom grid file and points drawn on the screen. While the Blast Pattern Layout routine also can generate a report, this routine is more flexible because it uses all selected points from the screen and is not limited to only pattern points. For example, you could use Blast Pattern Layout to create a grid of points. Then use Interval Along Entity to create points along a polyline that represents the setback line for the first row of holes. You could also use any of the other Carlson point routines to add or remove points. Then once all the points are placed, you can run Blast Point Report.

![Blast Point Report Window](image1)

**Prompts**
Cast Blast Report

This command uses before and after grid files to report blast volumes, swell and cast to final. Before running this command, you need four grid files and an inclusion perimeter. The inclusion perimeter is a closed polyline that follows the back of the cut area and the toe of the previous spoil pile. The first grid file is the original ground surface before the blast. The second grid file is the ground surface after the blast. The third grid file represents the bottom of the pit (design, or bottom of ore). For example, if you are blasting down to the top of ore, this grid should be the top of ore surface. The fourth grid defines the final pit surface including the final cut and spoil pile. This final grid can be created with the Make 3D Grid File command using 3D polylines for the toe of the highwall, toe of the spoil pile and top of the spoil pile.

The program calculates the volume between the original ground grid and the pit bottom grid within the inclusion perimeter. This volume is reported as the Original Volume. The After Blast Volume is the volume between the final ground grid and the pit bottom grid. The difference between the After Blast Volume and Original Volume is reported as the Swell Factor. The After Blast volume that is below the final pit surface is the Cast to Final volume.

Original Surface: C:\scad\DATA\ex.gnd.grd
Final Surface : C:\scadv\DATA\final.grd
Pit Bottom : C:\scad\DATA\coal.grd
Final Spoil : C:\scad\DATA\spoil.grd
Lower left grid corner : 509141.84, 595450.20
Upper right grid corner: 511087.39, 596727.09
X grid resolution: 100, Y grid resolution: 100
X grid cell size: 19.46, Y grid cell size: 12.77

Original Volume: 1602319.50 C.F., 59345.17 C.Y.
After Blast Volume: 2066992.20 C.F., 76555.27 C.Y.
Blast Swell Factor: 1.29
Cast to Final Volume: 144689.22 C.F., 5358.86 C.Y.
Cast to Final: 9.03%

Prompts

Original Surface Grid File
Final Surface Grid File
Pit Bottom Grid File
Final Spoil Grid File
Select the Inclusion perimeter polylines.
Select objects: pick a closed polyline

Pulldown Menu Location: Surface, Blast Pattern
Keyboard Command: blastinfo
Prerequisite: Original, final, pit and spoil grid files. Inclusion perimeter polyline.

Draw Centroid Point
This command draws points at the centroids of the selected polylines. In the section option, the areas need to be closed polylines representing the blocks to calculate the centroids of. This is useful for calculating haul distances and blast distances in section view. When choosing to come from a grid file, it finds the x,y position for the center of mass. Typically this grid would be the difference between existing and design surfaces, represented as a thickness grid. For example, this routine could be used to find the center of mass for a stockpile using a difference grid of the stockpile grid and base grid.

Prompts
Centroid from cross-section or grid file [Section/Grid]? S
Select closed polyline(s).
Select objects: 1 found
Select objects:
Center at 1462284.64,1971935.94

Pulldown Menu Location: Surface
Keyboard Command: plcenter
Prerequisite: Closed polylines for calculating the centroids

Output To Reame
Output to Reame creates a file with a .dat extension that is readable by the REAME2004 stability analysis program for cylindrical failure. The REAME program was developed by Dr. Huang of the University of Kentucky and is widely used in coal mine permitting in the state of Kentucky. The linkage has been tested and verified with the REAME2004.

The program is typically used after a final surface profile is laid graphically over an existing ground profile. You then graphically select the profiles to create the REAME input file. The routine not only creates the input file but provides options to draw the failure study region and key coordinates on the actual profile drawing. The only
significant condition to be aware of is that the profiles should rise upwards from left to right in the direction of increasing station.

To run the Reame program after Output to Reame, it is best to copy the .dat file just made into the directory containing REAME.EXE. Then run REAMEINP to revise the .dat file (to change aspect like cohesion, friction angle and unit weight) or REAME to run the stability analysis. It will ask: FILE NAME -? Enter the name with the .dat extension included. The enter 1 to input from file. The analysis is then completed and stored in a file REAME.TXT.

Prompts

Title of Stability Report: Valley Fill No. 1 (Reame expects this title line, so enter something!)
Select Files or Pick from screen (F or <P>): P; press Enter for the Pick option here. The select file option would require that you enter the name of an existing and final .PRO file.
Next a Profile Settings menu comes up, in which it is important verify scales and the correct starting station and elevation.

[Pick Lower Left Grid Corner <0.00,1445.00>: pick where the starting station and starting elevation grid lines intersect] Switch to int snap if that point is not an end point.
Select Final Grade Polyline: pick final grade
Select Lowest Surface Polyline: pick existing grade Phantom lines at right angles representing the proposed study area for stability analysis now appear.
Pick another Surface (y/n): n, Yes for adding more surface polylines to reame input
Minimum Depth (DMIN) for Failure Slice:
Lowest Surface:
Value for C <0>:
Value for Phid <40>:
Value for G <125>:
Note: Lines will not Appear at Right Angles if Vert. Scale is Exaggerated.
Translated Coords: (-10.0 68.9902) (515.0 173.99)
Is Stability Analysis Zone Acceptable (<y>/n):
Plot Stability Analysis Zone Lines (<y>/n):
Label the Zone Line Endpoints (<y>/n):
[Pick Points for Coord. Label (enter to continue): pick any ground line or final grade line vertices or endpoints for coordinate labeling] Each time you will also be asked:
[none] Pick Starting Point for Text: pick a point
Number of divisions along face of slope <4>:
Number of divisions perpendicular to slope <8>: 

Chapter 16. Surface Mining Module 2972
This would lead to 32 radius points from which to test cylindrical failure.

**Pulldown Menu Location:** Surface > Slope Stability  
**Keyboard Command:** reame  
**Prerequisite:** Surface profiles or polylines

---

**Draw Reame File**

The function allows the user to import their existing Reame file and draw it in the drawing. It prompts to select the RME file created in Reame.

**Pulldown Menu Location:** Surface > Slope Stability  
**Keyboard Command:** reameplt  
**Prerequisite:** Stability Reame file

---

**Output to SB-Slope**

The widely accepted and computationally powerful stability analysis package, SB-Slope has very limited functions for data and geometry modification. The procedure outputs the data files in the SB-Slope data format, thus providing powerful interface for geometry editing. The meaning of all data parameters remains the same as in conventional SB-Slope.

The user is prompted with a single dialog defining the majority of necessary parameters, followed by prompts for soil and water polylines, soil properties and finally the parameters of applied loads if any. For each soil type, the program prompts first to pick polylines which denote upper boundary of the soil (multiple polylines may be selected), and then to pick polylines which represent boundary of the soil and are phreatic lines.

Polylines from the second set may appear in the first set as well.

After all soil polylines, the free-water surface is entered if any and then user is prompted for the soil mechanical properties. At last, distributed loads are entered by picking a horizontal line, representing the load support area, and input of the load value.

**Pulldown Menu Location:** Surface > Slope Stability  
**Keyboard Command:** sbslope

---

**Draw SB-Slope File**

The function allows user to import his existing SB-Slope file into the drawing. Segments of the neighbor lines corresponding to the same soil are joined to simplify creation of new SB-Slope data file from the drawing. The following color scheme is used to mark elements of the layout:

- blue = free water surface  
- green = phreatic surface  
- red = places of load application

**Pulldown Menu Location:** Surface > Slope Stability  
**Keyboard Command:** rsbslope
Spoil Menu

Assign Spoil Names

This command attaches a spoil name and site name to closed polylines that are used as inclusion perimeters in the spoil routines like Calculate Spoil Volume and Spoil Placement Timing. This will create them one at a time, and is recommended if there are just a few to name. Other commands will create more advanced layouts of spoil perimeters for designs that require more perimeters.

Prompts

Label area names [Yes]/No? Choose whether or not to label.
Text height <2.78>: press Enter to accept 2.78 drawing units (ft or m tall) or enter a new text height
Auto place labels in center [Yes]/No? press Enter to accept to manually pick the label position, answer No to this prompt.
Select Inclusion perimeter polylines.
Select objects: pick closed polylines for areas to include in calculations
Site name <Site 1>: press Enter to accept Site 1, or type a new site name
Pit name <Pile 1>: press Enter to accept Pile 1, or type a new pit name
Specify another area [Yes]/No? press Enter to accept Yes or type N for no If you do specify another area, then the Site Name remains the same, but the Pile Name is automatically incremented by one for efficient naming.

Keyboard Command: spoilname
Prerequisite: Closed polyline
Pulldown Menu Location: Spoil in Surface Mine Module

Spoil by Interior Point

This routine is used to create spoil polylines from the existing linework by making closed polylines around points picked. The site and spoil names are user-specified and the spoil name is incremented after each new pile perimeter is created. This command uses the Boundary Polyline logic, using any linework (open or closed) and searches out from the picked point for the closed perimeter. It draws a new polyline in the specified layer.
• **Label Area Names**: Choose whether to label the pile perimeters or not

• **Text Height**: Set the text height in feet or meters based on the drawing setup

• **AutoPlace Labels in Center**: Yes to put the text insertion point on the centroid of the perimeter

• **Layer Name**: Select or enter the layer name to draw the perimeter and text

• **Site Name**: Specify a site name to give to all the new pile perimeters

• **Spoil Name**: Specify a name to give the first pile perimeter. Subsequent piles will increment the name by one automatically.

---

**Prompts**

**Pick point inside pile perimeter**: *pick inside a loop or linework representing the pile for the spoil polyline*

**Specify another area (<Yes>/No)?** If yes is selected, then the Pile Name is automatically incremented by one for efficient entry, such as Spoil 2. **Site name <Site 1>:**

**Pit name <Spoil 2>:**

**Pulldown Menu Location**: Spoil in Surface Mine Module

**Keyboard Command**: pickspoil
**Spoil Layout by Width**

This command creates closed polylines that represent spoil placement inclusion areas for the spoil timing routines. The spoil polylines are created by advancing a baseline polyline by a fixed pile width. The sides and end of the pit polylines are defined by the disturbance boundary polyline. This polyline should be open at the end of the baseline polyline. Be sure to create the baseline polyline longer than the overall boundary so that the program can always find the intersection of the advancing baseline with the boundary. There is an option to automatically assign pile and site names to the polylines. The name of the first pile is set in the dialog shown below. The next spoils will be named by incrementing the spoil name by one. There is an option to prompt for each spoil perimeter width or use the same width for all the piles.

![Image of Spoil Layout By Width dialog]

**Prompts**

- **Spoil Layout By Width dialog** Set the spoil width, layer and names
- **Select baseline polyline**: pick the polyline
- **Select spoil boundary polyline**: pick the polyline

*Calculating spoils ...

*Created 7 spoils.

**Pulldown Menu Location**: Spoil  
**Keyboard Command**: spoils

**Prerequisite**: One open polyline boundary and one baseline polyline extending across the boundaries open end.

**Find Spoil Name**

This command will find a certain named spoil polyline on screen. It will zoom to the pile extents and center it. The spoil line is also dashed or highlighted to distinguish it from surrounding polylines.
Prompts

Spoil name to find: pile 4
Site name to find <*>:

Pulldown Menu Location: Boundary
Keyboard Command: find_spoil

Label Spoil Names

This command labels the spoil name and site name that are attached to the selected polyline. Options for layer and text height are provided. The Horizontal and Align placement methods will draw the labels in the center of the polyline. The difference is that the horizontal option will draw the label horizontal to the current twist and the Align method will rotate the label to follow the main direction of the spoil line. The Pick method prompts you for a center point to pick and an alignment for the text.

Prompt

Label Spoil/Site Names Dialog
Remove Spoil Names

This command removes the extended entity data of spoil/site names from the selected polylines. For example if you are done calculating for an area, or you just want to clear and rename them, you can use this command to clear the spoil names from the polylines in the old area so that these polylines are not picked up as spoil perimeters anymore by routines for timing the spoil.

Prompts

Select polylines to remove spoil names from.
Select objects: pick the polylines
Removed pit names from XX polylines.

Clear Spoil Volumes

This command removes all quantity values and grid paths from the selected spoil polylines. There is the option to clear all benches at once, or if Specific is selected, then it will prompt to enter a bench number to clear.

Prompts

Clear all bench quantities or a specific bench [All/ Specific]? A
Select spoil polylines to clear.
Select objects: Specify opposite corner: 5 found, 5 total
Cleared 10 bench quantities.

Merge Spoils

This routine takes two adjacent spoil perimeters and merges them to create just one. Routines such as Spoil Layout by Width can sometimes leave small irregular shaped pits along complex boundaries. It is common to combine or add a small sliver of a spoil perimeter with an adjacent one so that the volume is added to that one. Pick first in the larger spoil that is to be kept, then in the smaller spoil that is to be removed. A new polyline is drawn around both, representing the new spoil with the same name as the first, larger spoil picked inside of. The last step is to simply erase the text of the smaller, deleted spoil (if they were labeled). If a spoil is selected on or near a common line, then the spoil is highlighted it prompts to hit Enter to accept the spoil or press N to highlight the other nearby spoil. The volumes are combined if they are already stored in the spoils as values.

The images below show the before and after of the Merge Spoils command.
Prompts

Pick inside 1st spoil polyline to merge: pick inside perimeter to keep
Pick inside 2nd spoil polyline to merge: pick inside perimeter to remove, and merge with previous
Created a shrink-wrap polyline successfully.
Done.

If the pick is near a common spoil line, then the following prompts appear:
Pick inside 1st spoil polyline to merge (Enter to end):
Press N for next selection or Enter to accept current:
Pick inside 2nd spoil polyline to merge:
Press N for next selection or Enter to accept current:
Created a shrink-wrap polyline successfully.
Done.

Pulldown Menu Location: Spoil
Keyboard Command: mergespoil
Prerequisite: Two adjacent Carlson named spoil perimeters to be combined into one larger spoil perimeter.
Assign Directions

In order to schedule the spoil polylines (which are closed polylines), they must have directions assigned. The Assign Directions command places the direction of spoil placement into the spoil polyline itself, where it is permanently stored along with other aspects of the drawing. Directions can vary by bench. The command prompts to assign the same direction to the Whole spoil polyline, or by bench. If doing by bench, the routine must be run separately for each bench.

Assign Directions is found within the Spoil menu in the Carlson Surface Mining. There are six methods employed to assign direction: Automatic, Text, Sequence, Polyline, Bearing and Azimuth. The "automatic" method will move "longways" across the pile, following the longest axis detected, but may not choose the preferred direction along that axis. The text method finds the side closest to the insertion point of the pile name and will mine from that side perpendicular across the pile away from the text. The sequence method will mine left to right and/or right to left across a series of piles as specified by the user, the polyline method will follow a "direction polyline" across a pile or series of piles and the Bearing or Azimuth method will mine at defined bearing or azimuth angle. Below is the prompting and results obtained with each method:

Prompts

Assign direction using which method [<Auto>/Text/Sequence/Polyline/Bearing/AZimuth]: A or press Enter
Select pile polylines to have direction assigned to:
Select objects: Pick the piles and the direction is assigned as shown below

In this example, it uses the long axis of the pile, and alternates back and forth for direction. It is a quick way to get directions assigned. A pile direction can be easily reversed using the Reverse Directions command.

Next are the prompts for the Text option.

Assign direction using which method [<Auto>/Text/Sequence/Polyline/Bearing/AZimuth]: T
Select pile polylines to have direction assigned to:
Select objects: pick the piles and the required pile text as shown below
The highlighted pile has the direction information assigned already.
Would you like to overwrite this (<No>, Yes, None, All): A for All. This prompt only occurs when piles are chosen that already have pile direction. Note that the command 'Clear Directions' could be used to remove directions prior to using Assign Directions.

The arrows show the resulting directions. Note that this routine looks for the pile name for the direction, not for the "site" name. (All piles have a two-tiered naming convention: site and pile, which can be re-worked as pile and block or any other two-level form, to adapt to company practices.)
Next is the Sequence option.

**Assign direction using which method [Auto]/Text/Sequence/Polyline/Bearing/AZimuth**: $S$

Select pile polylines to have direction assigned to:

**Select objects**: select the piles (Don't worry if you also select other polylines. It only finds piles.)

**Select a direction polyline.**

**Select objects**: select a polyline that crosses all of the piles

**Assign direction in which sequence (LL, LR, RL, RR)**: $LR$

In our example, we selected LR, which causes the piles to be filled left to right on the first pile (with respect to the south-to-north direction polyline–imagine yourself standing at the beginning of the polyline looking down it. LL would fill all piles coming from your left. LR would fill from the Left first, then the Right in the next one and so forth. RR and RL are just the opposite.), then right to left on the second pile, then left to right on the third, etc. An entry of LL would cause the piles to be filled from the left side to the right side. An entry of RR, for example, would fill all the piles from right to left. The entry of RL would fill first right to left, then left to right. The sequence method is ideal for assigning direction to a series of long and narrow piles that have not been broken up into small blocks.

If these same piles were each subdivided into 10 or more blocks, or there are many piles that would not be intersected by the sequence polyline, for example, then the following method, direction by polyline, is most appropriate.

Next is the Polyline option.

**Assign direction using which method [Auto]/Text/Sequence/Polyline/Bearing/AZimuth**: $P$

Select pile polylines to have direction assigned to:

**Select objects**: select the piles

Select all direction polylines.

**Select objects**: In the example above, select the single direction polyline.

The polyline-based selection is ideal for piles that follow sinuous property lines. Direction polylines cannot have arcs, so if you've used an arc to draw the polyline, use the command Remove Polyline Arcs on the Edit menu to remove them.

Lastly, are the Bearing and Azimuth option
Bearing Option:

Assign direction to whole pile or to a specific bench [Whole/Bench]: W or Enter to assign direction to whole pile
Assign direction using which method [Auto/Text/Sequence/Polyline/Bearing/AZimuth]: B for Bearing
Select pile polylines to have direction assigned to:
Select objects: select the piles
Enter Bearing (Qdd.mmss): 145.0000
The highlighted pile has the direction information assigned already.
Would you like to overwrite this [No/Yes/None/All]: A for all

The Bearing is entered in the format (Qdd.mmss), the following figure shows the quarter numbers and the angle is calculated clockwise.

Azimuth Option:

Assign direction to whole pile or to a specific bench [Whole/Bench]: W or Enter to assign direction to whole pile
Assign direction using which method [Auto/Text/Sequence/Polyline/Bearing/AZimuth]: B for Bearing
Select pile polylines to have direction assigned to:
Select objects: select the piles
Enter Azimuth (ddd.mmss): 135.0000
The highlighted pile has the direction information assigned already.
Would you like to overwrite this [No/Yes/None/All]: A

The Azimuth angle is calculated from the true north as 0, rotating clockwise.

Pulldown Menu Location: Spoil
Keyboard Command: spoil_assign_dir
Related Commands: Display Directions, Reverse Directions, Clear Directions, Create pile Plines from Mineplan

Display Directions
If directions have been assigned to spoil polylines, this command will display the directions. It therefore serves two purposes: (1) to verify that directions have, in fact, been assigned previously, and (2) to review the direction
of filling spoils. When pile directions are detected, arrows are displayed as shown below. These direction arrows will disappear with any "Zoom" command such as Pan or Window, and will also disappear if a Redraw or Regen is executed. The direction leaders can be used to draw direction arrow entities in the drawing, with the leader arrow size a prompt option.

Prompts

Display direction to whole pile or to a specific bench [Whole]/Bench: W
Draw directions as leaders or temporary arrows [Leaders/Arrows]? L for Leaders or A for Arrows
Select pile polylines to have direction displayed:
Select objects: Pick the polylines to display
Pulldown Menu Location: Spoil
Keyboard Command: spoil_display_dir
Related Commands: Assign Directions, Reverse Directions, Clear Directions

Reverse Directions

This command reverses the direction of advance within a spoil polyline. It is particularly useful in conjunction with the command Assign Directions, <Auto>, since the automatic mode may assign direction to many of the piles opposite from the desired direction. The result redraws the arrows in the new direction. If Leader arrows were drawn, then they are erased and redrawn in the updated direction.

Prompts

Reverse direction to whole pile or to a specific bench [Whole]/Bench:
Select pile polylines to have direction reversed:
Select objects:
Clear Directions

This command removes the directions from piles. The Extended Entity Data (EED) designating pile direction is removed from the pile polyline entity. This command has no effect if direction has not been previously assigned to a spoil polyline. Keep in mind that it is not necessary to first remove "old" directions before assigning "new" directions. The Assign Direction command will recognize that directions exist and will prompt the user to overwrite the direction for individual piles or for all piles.

Prompts

Clear direction to whole pile or to a specific bench [Whole]/Bench:
Select pile polylines to have direction removed:
Select objects: pick the pile polylines This can be done individually or with a window.

Calculate Spoil Volumes

This command calculates the volume of the spoil based on the selected grid surfaces. There are options to select the Top Fill Surface, Bottom Fill Surface and two optional top and bottom of bench grids. This command needs to be run separately for each bench to calculate the volumes for each one. The volumes are automatically stored in the spoil polylines, ready for the timing process. They can be verified and edited with the command Edit Spoil Volumes.

The following example shows how to store volumes for two benches. The required surfaces are set by picking the top of the pile elevation of 4850, and the bottom of the pile, stacked onto the original Surface Topography grid. Bench 1 will be from the top of pile, also 4850, down to 4825 elevation grid. Bench 2 will then be from 4825 elevation to the bottom surface, the Surface Topography grid.
The Report Formatter window displays the available attributes to report, such as Spoil, Site Name, Bench#, Fill in CF, CY or CM if metric.

The report can be viewed with the Display button, or taken into Excel with the export to Excel option.
Prompts

Select spoil polylines to process.
Select objects: Specify opposite corner: 6 found
Select objects:
Pre-processing grid cells ...

Keyboard Command: calc_spoil
Prerequisite: Closed polylines named as spoil polylines
Pulldown Menu Location: Spoil in Surface Mine Module

Edit Spoil Volumes

This command displays the spoil destination results in a spreadsheet editor. The Site Name, Pile Name, Bench, Volume and Centroid are in individual columns. This is an editor where the data can be reviewed to see what the volumes are. Any changes made here can be used for the spoil timing and reporting.

Prompts

Select spoil polylines to process.
Select objects: Specify opposite corner: 6 found
Select objects:
**Keyboard Command:** edit_spoil  
**Prerequisite:** Closed polylines named as spoil polylines assigned volumes.  
**Pulldown Menu Location:** Spoil in Surface Mine Module

---

**Edit Spoil Source**

This command brings up a table of the Spoil Source that is required for the Spoil Timing commands. This displays where the material to be placed in the spoil polylines will come from. It shows the Site and Pit names to be mined. It also shows the Bench number, period or strata for each bench, full name and volume. If the SPO was created with the Surface Equipment Timing commands, then the Period will be used instead of the Strata Names, and the Mining Period Start and End dates will be correctly assigned. Otherwise, from Surface Mine Reserves, just the Strata Names and their volumes will apply.

This image shows the source of the spoil material calculated with Surface Mine Reserves.

![Image of Spoil Source](image1)

This image shows the Spoil Source calculated on the same pits, but with Surface Mine Reserves, over three benches instead. It shows the Period instead of strata names, and the Mining Period Start and End dates are straight from the Surface Timing command, into the SPO file.

![Image of Spoil Source](image2)

The Apply Swell will swell the calculated volume stored in the SPO file. If it isn't swelled, then it will use the in-place, bank volume. The value is a percentage greater than 1.0. For example, 1.2 is a 20% swell of the spoiled material. Once OK is selected, the volumes should change on screen to a larger, swelled volume.

---

**Chapter 16. Surface Mining Module**
The Report button will bring up the Report Formatter where the requested fields will be reported in the text window, or exported to Excel. Shown here is an example text report.

Keyboard Command: edit_spo
Prerequisite: SPO file from Surface Mine Reserves or Surface Equipment Timing.
Pulldown Menu Location: Spoil in Surface Mine Module

**Spoil Placement Timing**

This command brings all the spoil commands together as final step and performs the timing and scheduling of the spoil placement. The first window is to select a new Spoil Timing Project file, or load an existing one (*.SPD file).
Once the SPD file is named, then the Fleets and production are defined in the next window, if there aren't any in the file already. The green + and X buttons are for adding and deleting the rows. Give each fleet a name and a production per hour, and hours per day worked on average. If a fleet is already saved, it can be loaded with the Load button.

The next step is to load the Spoil Source file (*.SPO) that was created with either Surface Mine Reserves or Surface Equipment Timing.
The Spoil Source editing window will appear next. This gives the opportunity to review the source data and make any final edits before scheduling. The data in the image below came straight out of the Surface Equipment Timing command.

The next screen will be the Spoil Timing Project manager. This shows a tree structure of the project which is comprised of 3 main areas, including the Haul Fleets, Spoil Sources and Spoil Destinations.
After the Spoil Timing Project screen, where all the items can be viewed and edited, clicking OK brings up the Spoil Placement Timing window. This is where all of the assigning and reporting of the schedule is set.

This is the main dialog for sequencing the spoil timing. It is divided into 4 main areas, and they are described with the matching numbers labeled on the image for clarity.
1. **Spoil Source** section shows a list of available spoil sources from the Spoil Source file that was used. They can be edited with the button, and sorted up or down. The procedure is to move them from left to right, in order to be filled by the mining.

2. **Haul Fleet**: This section shows the list of haul fleet units that are defined. Edits can be made here. To set one current, just pick it and keep it highlighted while timing spoil.

3. **Spoil Destination** section is the method to define where the spoil cuts are going. In this example, there are both in pit and out of pit spoil locations. Multiple benches will be displayed with B1, B2, etc.

4. **Calculate** is used to run the timing and get the reports once the spoil sources have been assigned to a destination. Enter in a start date if it is changed. The Shifts/Day displays how many divisions are displayed in the white window below. The gray grid lines are the shifts per month. If only 1 shift per day is selected, then each grid line is a full day.

5. Each period is divided by the red, vertical lines. This example shows months.

6. The dark blue gantt chart bars are the spoil sources. The gray bars are the spoil destination perimeters. Each spoil source has to go somewhere, once that source is used up, then the destinations go to the next source.

Once selecting the Calculate button, the next window determines the type and options for reporting. If any of the report types are set to just periods, then the window will appear like this.
If the Spoil Source File is selected, then the periods set there, created from Surface Equipment Timing, will set the period intervals. This also activates the Use Equipment Timing Grids, which will use the GSQ grid sequence file, and merge that with the spoil surfaces per period.

To select the output grids for the 3D spoil results, the surface topography, final ground surface grid is set here. Also, the top of each bench grid file is set here, for multibench spoil. These grids can be made with Grid File Utilities to set the designs by area or inclusions. For example, the top of Bench 1 could be a combination of the post mining topography for in the pit spoils, and a fill design elsewhere, for out of pit spoiling and dumping.
The program will now prompt for the existing GSQ Grid Sequence file to use. This file contains the advance of just
the pits in the mining sequence. It will now use this file, matching up the periods, and add in the back fill spoiling.
This will represent the full mining progression, showing the advance of the pits, and the following of the spoil and
dumps.

The plan view map is hatched with the color period blocks to illustrate where each spoil is placed in each period.
This creates a new GSQ file, with the name defined above in the Define Surface Grids window. It uses the name define here by default, SpoilGrids. Viewing this file with the View 3D Surface History will show the mining progression with the spoil fills.

Using the Report Formatter can export the report directly into Excel. An example Excel dump is shown here.
Keyboard Command: timespoil
Prerequisite: SPO file from Surface Mine Reserves or Surface Equipment Timing, spoil polylines with direction, and haulage fleet.
Pulldown Menu Location: Spoil in Surface Mine Module

Case Studies

Case Study #5: Surface Timing With Benches

This next tutorial shows how to run Surface Equipment Timing through a series of benches in pits. This example starts with a pit layout mineplan and structure grids. It is assumed that you already know those operations. Then Design Bench Pit is run on the pits, creating output grids and a Grid Sequence File. Next the quantities for each bench will be calculated and stored in the pit polylines. Then the sequence of mining the benches and pits is assigned and run with Surface Equipment Timing.

Creating Pit Polylines

The first step is to sub-divide the overall pit perimeter into smaller pits. In this example, the larger rectangular mine perimeter is subdivided into 5 smaller pits, named Pit-1 through Pit-5. These will be draped onto the bottom of the pit and benches will go up and out from them. The command Pit Layout By Advance was used to lay them out.
Assigning Pit Directions
In order to schedule the equipment through the pits, the direction of mining needs to be assigned to each pit. In this case, the direction of mining for each pit will be from left to right. First draw a direction polyline through the pits from bottom to top. Then run the Assign Directions command and use the Sequence method with the LL option.

Assign direction using which method (<Auto>, Text, Sequence, Polyline): S for Sequence
Select pit polylines to have direction assigned to:
Select objects: select the pit polylines
Select a direction polyline: pick the direction polyline
Assign direction in which sequence (<LL>, LR, RL, RR): LL

The pits now have direction assigned from west to east.

Design Bench Pit
Using the pit perimeters as the inclusion areas, the program will draw the 3D pit shells, output grids and calculate volumes for each pit and bench. Before running Design Bench Pit, you need the pit bottom perimeter polylines and grid files for the ground surface and benches. In the first dialog, specify the ground surface grid and the bottom elevation grid for the last bench. Also be sure the Process Multiple Polylines by Pit Names and Write Surface History. A grid file for each pit and each bench is created, and they are automatically organized in the Grid History File (GSQ).
In the next dialog, you specify the side and bench slopes. The height of the side slopes can be specified by either a depth number or a grid file. In this case we will use grid files as well as by depth. Four different sets of slopes can be applied to different sides of the pit. For this example, the same slopes will be used on all sides. You can use up to 100 benches.

The output will look as such. Each pit is in its own layer and colored differently. In the above view, the pits are laid down on the side, to show the slope to each grid.
Assigning Bench Quantities

The next step is to store quantities in each pit for each bench using the Surface Mine Reserves command. Before running this command, you need to have a Pre-Calc Grid file (.PRE) in addition to the GSQ history file. This is what determines the bench quantities and automatically assigns them to the benches. Use the Define Pre-Calc Grids command to specify the grids as shown below.
Then run Surface Mine Reserves. The dialog shown below appears. Set the modeling method to Pre-Calculated and you can leave it set to Bench 1. Since we are using the GSQ file, all five benches will be assigned automatically. Turn on all the options you see here.

Some important items to make sure are selected are Use Surface History, Use Named Pit Areas, and Store Results in Pits. After clicking OK on the dialog, specify the Pre-Calc file shown above. Next the program prompts for the Grid History File created earlier by the Design Bench Pit routine. The Merge Bench Quantities Percent applies here. If there is some grid “bleeding” where one seam bleeds into another bench due to the grid cell size, then this option will put that material back into the correct bench, as long as the amount is not less than this percentage.
Now the program will calculate the quantities of all the benches for all the pits. A report formatter allows you to optionally print or display the results. The quantities are stored in the pit polylines for scheduling. If you are not using the GSQ file, then you will have to run this for each bench number, with all the same options except set the Bench # to 2 and choose only Bench 2 from the strata list (Selected Strata turned on). Then repeat this command a third time using bench 3 etc. That is what is nice about the GSQ file, it does them all at once, even calculating and assigning the layback slope volume accordingly. Shown next is the pit by pit and bench by bench volume report.

These values are now stored in the pits and can be verified with Edit Pit under Boundary. Click inside any one of the pits to see the values. All benches can be accessed by selecting the bench number in the tree view on the left of the dialog or by selecting the Spread View tab to view data for all benched at a time.

Chapter 16. Surface Mining Module

3001
Surface Project Manager

The Surface Project Manager can be accessed under Reserves/Timing dropdown menu. It allows user to define Equipments, Timing Calendar, Pit Attributes as well as other essential parameters to be used in the timing.
Define Equipment
Select the Edit Set in Project Manager to create an equipment definition to mine the pits. This example will use three shovels. This command shows a list of existing equipment definitions. Choose the Add button and fill out the dialog as shown below for a three shift operation for all shovels. Shovel 1 mines 24000 CY/shift and Shovel 2 and Shovel 3 mines 12000 CY/Shift.
Define Calendar

The next step is to define the calendar. By default, both units are working every day, every shift. It is your job to take off holidays, weekends and maintenance down time.

Surface Equipment Timing

The Surface Equipment Timing command schedules the equipment through the pits. The first dialog shows three list boxes for the equipment, the pits assigned to the equipment and the unassigned pits. The pit benches are listed as site name - pit name - bench number. For example, "Site 1-Pit 1-2" is for bench 2 in pit1. To set the equipment to
use, choose the Add Equip button and select the equipment name defined in the last step.

The sequence of mining the pit benches must be assigned. In this case, we want a 5-step staircase that advances through the pits. By default the pit benches are sorted in the unassigned list by pit number then bench number. To arrange the pit benches in the staircase order, choose the Sort dropdown list and select 5-Bench Staircase. Then pick the Select button followed by the Assign button. This will assign the pit benches to the equipment in staircase order. In this example, just manually select the first pit/bench, and holding the CTRL button down, select every other one. Then hit Assign, assigning them to Shovel1. Then highlight Shovel2, hit Select All, and assign the remaining pits/benches to Shovel2.

Shown above are 6 profiles of the bench pits. They have been manually connected with polylines and the pits and benches are labeled to show the "blocks". This is to illustrate the real bench width in cross section view. The lower graphic shows this profile exaggerated and numbered exactly as each block is going to be sequenced in the 5 bench staircase method. The sequencer automatically sorts them in this order.

The 3D Pick option can be used to graphically select each bench and pit in the order to be mined. It is very useful for short-term scheduling. Just select 3D Pick, rotate it to an useful 3D view and then double click on each block. It will be removed and assigned to the highlighted unit.
When all the pit benches are assigned as shown in the dialog, click the Calculate button. The program will then run the equipment through the pits and report the completion date. Then click the Detailed Report button. This brings up the Report Options button.

In this case, the report period is set to Show 1st Days of Months. This will give a monthly schedule from the first of each month. Following is a report by monthly period. This can be formatted in many ways and exported to Excel.
Case Study #7: Dragline Range Diagrams

This tutorial shows how to design steps of Cast Blast Profile, Dozer Push and Cut & Place in cross section for dragline extended bench and spoil side methods. It then takes this design "template" and applies it to plan view in 3D, extruding it up and down the pit using a centerline file (CL). Other routines we will use include Define Dragline Equipment, Cut Only (coal removal), Draw Dragline limits and Flatten Spoil Top.

Creating Surface and Strata Cross-Sections

The first step is to generate a cross section of the ground surface and desired strata. This can be accomplished with the fence diagram routine, or drawing multiple profiles or sections that represent these surfaces on a grid. If the fence diagram method is used, be sure and turn off hatch fence diagram, and turn on draw strata polylines as single polylines. Otherwise, the strata will be closed polylines and the program won't use them correctly. If the profile crosses an existing, open pit and seams are cropping, be sure to turn on Draw Surface Polyline in Fence Diagram. This will draw a continuous polyline across the entire length of the section, needed for Cut & Place. Shown is a cross-section of an existing pit. In all diagrams, the existing ground polyline will be represented by the thicker, black line.

EXTENDED BENCH EXAMPLE

Cast Blast

The first operation is to simulate the cast blast for creating the extended bench. The generic profile of the blast can be defined as either a Carlson profile (*.pro) or as a polyline drawn on the screen, above the fence diagram. The profile file or polyline must be created before running Cast Blast. For example, you can draw the typical blast profile on the cross-section view. The program will move the polyline up or down to balance the cut and fill areas. First, the program has a dialog box for options.
In this case, the swell factor was set to 1.2, or 20% and the profile by polyline option was used. Then select the ground and top-of-strata polylines. Next pick the blast or cut area, this example used the lower left and lower right cut points. The left point in this case should be at the cut width, and the right point is snapped to the intersection of the top of coal outcropping at the existing ground surface.

After the program places the blast, it prompts the user if there is any vertex on the blast that needs to be moved or changed. Simply pick the position and the line will move to that location. The existing ground surface line has now been changed, and is ready for the next step.

**Dozer Push**

Now the Dozer Push command is used to create the extended bench.
In the dialog box, set the Pit Push Percent to 0%. This will push the material horizontally out into the pit. Turn off Label Push Distances, otherwise it will label the complete surface line. Also set the swell to 1.0 since this material has already had the swell factor applied from the Cast Blast. Choose OK and pick the left and right cut points as shown below. Use the Nearest Snap to pick the right cut point so it connects directly on the existing surface line. The left and right cut points should be selected at the same elevation if the push is to be flat before the pit also. The existing surface polyline has now been updated and is ready for the next operation.

![Diagram showing Dozer Push Settings and cut points](image)

**Define Dragline Equipment**
This routine simply defines the dragline parameters and dimensions for drawing its reach, depth and height on the range diagram. Fill in at least the required size parameters on the left side of the box. Many Companies supplied their dragline parameters and are on the list for easy reference.
**Draw Dragline Limits**

This draws the workable limits of the dragline on the range diagram cross-section. Pick the existing ground polyline and the location that the center of the machine is sitting. A block of three lines is drawn representing the height, digging depth and horizontal reach of the dragline. There is a vertex placed at the intersection of the ground surface, this is the point to pick for moving the block to the next cut. The vertical line above the vertex is the height, and the line below the vertex is the digging depth. These are the limits to stay within when cutting and placing spoil. There is an option to draw a dragline icon, and also to label the swing angles across the top. This allows you to keep the spoil placement within a certain swing angle. There is a prompt to use a reference point. This could be the crest of the highwall. If one is picked, then it prompts for a distance from that reference point to the center pin of the dragline. Negative values will offset it to the left.
Cut and Place
The next step is the Cut & Place command for the dragline work. In the dialog, set the right highwall angle to the repose angle of the spoil. This will ensure the cut and spoil are the same angle. Also set the spoil placement method to Left Toe.
After selecting OK, pick the ground and strata (top) polylines. Next, pick the left cut, right cut and spoil location points as shown. It is very helpful to use the Osnap endpoint and intersection to get the exact points. Notice how the right highwall angle and the spoil match for an accurate representation of the slope. Again, there is no need to swell the material as it has been already swollen from previous operations.

**Cut Only (Coal Removal)**
The final step in this example sequence is the removal of the coal to prepare the new existing ground surface for the next cut/spoil placement. Like Cut and Place, this routine also allows for differing left and right cut slopes. The strata polyline in this case will be the bottom of coal polyline, which will bring the existing ground polyline down to it.

**SPOIL SIDE BENCH EXAMPLE**

**Cast Blast**
The initial cast blast is the same as the extended bench example in the previous pages. Shown is the cross-section after the cast.

**Spoil Side Bench**
The Cut & Place routine will be used to create the spoil side bench in this example. In the dialog box, set the Top Spoil Width to the bench width (in this case, 100 feet). Then choose OK and select the ground polyline and cut...
points as shown. Again, the snap nearest is useful for selecting the right cut point. Do not select a strata polyline, as we are not going down that deep in the cut. To place the spoil, be sure to select either left or right toe for location method, as there is no spoil peak with which to place it. After placing the spoil pile, there is an option to adjust the left and right cut points. Any adjustment of the cut area is automatically reflected in the spoil bench, which allows you to adjust the spoil bench height.

Draw Dragline Limits
The next step is to show the dragline limits when placed on the spoil side bench. Use the same procedure as in the extended bench example. Another option is to create a block drawing of a dragline and insert it into the drawing to represent the correct dimensions. Shown below is a block of a dragline to scale, inserted into the above range diagram.
Cut & Place
The next step is the Cut & Place routine for the dragline pass. In the dialog, set the right highwall angle to the repose angle and set the spoil placement method to Left Toe. Also set the Top Spoil Width back to zero. Then click OK and select the ground and strata polylines. Next, pick the left cut, right cut and spoil pile points as shown. Notice the right cut point is to the right of the coal block to ensure it is uncovered and minimize rehandling. You can use the Osnap-endpoints to get the exact points. To start the spoil pile 20 feet from the spoil side bench, use the distance option and pick the edge of the spoil side bench as the reference. Type in a positive value to offset to the right and negative to offset to the left.

Cut Only (Coal Removal)
As in the previous example, the coal removal is the last step to prepare the existing ground surface for the next cut. The right side cut angle is again set to the same angle as the spoil repose to simulate the spoil down to the bottom of the removed coal block.

Process Dragline Sequence
One thing not mentioned in the previous examples is the saving of each step to a dragline sequence file. The option to store each step in a sequence file is set at the bottom of the dialog boxes. Typically the first step is saved to a New file as sequence step #1, and each subsequent step is appended to that file as #2 and up. The next example will show a simplified two-cut Cut and Place on a fence diagram and then processed with a centerline to generate 3D polylines drawn in plan view and sections. The first step is drawing the fence line and intersecting it with the centerline for laying out the cuts/pits as shown in the diagram below. This intersection will be known in the commands as the centerline reference point. Then draw the fence diagram with the hatching turned off and draw as single polylines turned on. This will provide an existing ground surface with the strata lines below it. It is usually better if there is
Cut & Place
After drawing the dragline limits, the Cut & Place settings need to be set as shown to the right. A 20% swell has been set, and it will be stored to a new step file as shown with sequence number one. This will be a simple box cut for the first sequence. Step two will be the coal removal, and step three will be the next cut and spoil placement. After step three, the sequence file will be processed and turned into 3D polylines and a section file (*.sct). The first step is shown below:
The first prompt after selecting the existing ground surface is to pick the centerline reference point. In this example, it is station 5+00 and it should be "snapped" to at the intersection of the horizontal grid line and the 5+00 tick mark. After selecting the top of strata polyline, you are prompted to enter the name of the strata. This name will be used later in prompting to select that surface grid file. Select the left and right cut points and the spoil location. Notice the two cuts were drawn in by hand to guide the user in the correct location of the cuts. This is sequence step number one.

**Cut Only (Coal Removal)**
Step number two will be the removal of the coal block. The cut angle will be set to 89 degrees on each side to simulate a near vertical face of coal after it is removed. Try to stay away from pure 90 degree slopes, as AutoCAD has difficulty sometimes. The strata line will be the bottom of coal this time, and you will be prompted to specify a name for that surface. (BOC for bottom of coal works) You will also be asked to snap to the centerline reference point (5+00).
Cut & Place

The third and final operation in the sequence will be the second cut with spoil placement into the first cut. Everything is about the same except for the sequence number needs to be set to three, and it should change automatically. Shown is the final result, sort of a template that will be applied now to our centerline (*.CL file) utilizing the surface grids and create a new surface for possible PMT application.
Process Dragline Sequence

If it has not already been done, use the routine Polyline to Centerline File to create the *.CL necessary for the processing of the sequences. The following window will appear, and needs to have at least the first three files set. It will also create an output section file for later manipulation. The Taper Spoil Sides will taper the ends of the spoil gradually down to the existing ground. The draw pit polylines will create new pit/cut polylines to run for scheduling. After selecting OK, you will be prompted for the grids representing the strata named in the previous routines.

Shown below are two 3D views of the cross section lines that were automatically drawn at the specified 100-foot interval. For visual clarification, the 3D polylines were also contoured to begin building the new surface. Notice the pit is only as long as my centerline was drawn. The top image is a rendered image of Triangle Faces that were drawn.

Another nice feature is to draw a 3D dragline and place it in plan view. This dragline shown was simply drawn with AutoCAD 3D faces and moved to the plan view. It gives good presentation material.
Draw Section File
Another step is to draw the section file created in the processing of the sequence. Shown is a partial series of sections created with the Carlson Range Diagram routines.
This section contains a dozen tutorials designed to assist you in learning the Carlson Survey/Civil/Hydro product line. They are:
Lesson 1: Entering a Deed

In this short lesson you will create a simple drawing. You will enter a 6-sided deed, add a title block, bar scale, and north arrow, add a title and certification text, and plot the deed area.

Note that the Esc key will cancel most commands, so if you choose the wrong command or enter something incorrectly and want to start over, just press Esc.

1 Click the icon for Carlson. You may be presented with a Startup Wizard dialog box. If so, click Exit.

2 Under the Settings menu, click Drawing Setup. Set the unit setting to English and the Horizontal Scale to 50. Click OK.

3 Choose Point Defaults from the Points menu, and, in the dialog box, click Elevations off to eliminate the Elevation prompt. Click Descriptions on and also set the point symbol name to symbol 4 (SPT4), which is the round, open circle. Click Automatic Point Numbering on. Click OK.

4 Under the Survey menu, select Enter Deed Description. The following dialog box will appear so you can specify where to store the coordinates:
Select the New tab. Then, for the File Name, type in "Deed". This creates a file called Deed.crd. All Carlson points are stored in files with the "crd" extension, which stands for "coordinates."

Now use the default settings as shown in this dialog box image. Click OK.

The command line is the area below the graphics and to the left. When prompted to "Pick point or point number" at the command line, pick a point in the lower left quadrant of your screen to start the deed plotting. Respond to the command line prompts exactly as shown here:

When you are prompted for a description, enter "Fence Post".

**Exit/Curve/<Bearing (Qdd.mmss)>**: 125.3500

The quadrant (Q) is 1 for Northeast (2 is Southeast, 3 is Southwest and 4 is Northwest). The bearing is 25 degrees,
35 minutes, and 00 seconds. If all digits for the minutes and seconds are entered as shown above, then the deed call will be fully plotted, including the seconds. If only the degrees and minutes were entered, as in 125.35, then the plot would appear as "N 25d 35' E".

Varas/Meters/Poles/Chains/<Distance(ft)>: 200.51
Note that you can enter old deeds in the forms of Poles and Links, Chains and Links and even Varas (a unit of measurement formerly used in the southwestern states of the U.S.).

Enter Point Description <Fence Post>: Iron Pin

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 189.4321
Varas/Meters/Poles/Chains/<Distance(ft)>: 225.00
Enter Point Description <Iron Pin>: press Enter
Pressing Enter selects the default, which is Iron Pin.

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: C
Tangent-out/<Radius>: 75
Curve direction [Left(-)/<Right(+)>]? press Enter for right
Non-tangent/Reverse-tangent/Bearing/Chord/DeltaAng/Tangent/<Arc Len>: 118.17
If you don't know the arc length, but you know the tangent, you would choose "T" for tangent.

Enter Point Description <Iron Pin>: Concrete Monument

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 200.0000 (due South)
If you were to enter just 2 (no degrees, minutes, or seconds), then the deed call would be plotted "S 000 E".

Varas/Meters/Poles/Chains/<Distance(ft)>: 178.00
Enter Point Description <Iron Pin>: Fence Post

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 488.2300
This entry specifies Northwest 88 degrees, 23 minutes.

Varas/Meters/Poles/Chains/<Distance(ft)>: 300.34
Enter Point Description <Concrete Monument>: Fence Post

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: 454.1109
Varas/Meters/Poles/Chains/<Distance(ft)>: 106.93
Enter Point Description <Fence Post>: press Spacebar, then press Enter

Simply pressing Enter uses the default text (Fence Post) again. To avoid drawing the text "Fence Post" twice on the end point, press the spacebar, skip a blank character, and press Enter.

You have now completed the 6-sided figure (including one curve).

Undo/Exit/Curve/<Bearing (Qdd.mmss)>: E

The following results are reported:

Closure error distance> 0.01709  Error Bearing> S 52d5'26'' E
Closure Precision> 1 in 66076.892  Total Distance Traversed> 1128.950

The resulting deed, has a closure of 1:66077. In the initial prompt "Undo/Exit/Curve...", U for Undo would allow you to reenter the previous deed call.

Use the Extents command on the View menu to see the entire area. Then choose Zoom Out under the View menu giving you adequate room for the next step.

5 Under the Settings menu, select Title Block. The dialog you will see is shown here:
The following dialog appears, allowing you to enter the attributes for the Title Block, select OK to go to the next dialog.

Completed the title block entries, as shown above. Select Paper Size B2 (11 x 17), and enter the layer name of BORDER, then choose OK.

You will be prompted for the border location, pick a point in the lower left of the survey. Note that the title line is plotted in large text on the title block. Its length, therefore, should not exceed 15 characters.

Your drawing should look like the example below at this point.
Use the Extents command, found in the View menu, to see the entire working area. If you want to move the border, use the Move command on the Edit menu. Pick the border lines and the title block objects (up to 3 picks total), press Enter (to end object selection), then pick two points representing the vector of the move.

If you want to see a margin around the working area after you use the Extents command, use the Zoom Out command on the View menu. Then use the Window command on the View menu to capture the view and margin you prefer.

If you make a mistake, enter U for undo, or select the back arrow icon that appears at the top of the screen.

6 On the Annotate menu, select Draw North Arrow.

Accept the default north arrow that is shown at the right side of the dialog, click OK, and place it in the upper right of your drawing. Choose Move on the Edit menu (or Enter M for move at the command line) and move it.

7 On the Annotate menu, select Draw Barscale. Accept the defaults, and then pick an insertion point below the north arrow and directly above the “a” in Farmer, and approximately the same distance from both. You can move the bar scale using the Move command on the Edit menu, if you need to do so.

8 On the Draw menu, select Standard within the Text command. Respond to the prompts as shown below:

Specify start point of text or [Justify/Style]: J for justify
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: C for center justified
Specify center point of text: pick a point near the top-center of the drawing
Specify height <4.00>: 10 Entering 10 makes the title text bigger than the default.
Specify rotation angle of text <E>: E
To enter a certification in the lower-right of the drawing, again select Text > Standard from the Draw menu, or type "dtext" at the command line. If you haven't done anything else, such as Zoom or Pan, you can simply press Enter to repeat the last command. If pressing Enter does not repeat the Text command, press Esc to cancel. Enter Dtext at the command prompt, and respond to the resulting prompts as shown below.

Pick a point above and to the left of the title block for the certification. You don't have to enter L for left-justification. The Dtext command defaults to left-justification every time.

**Height <10.00>:** 4
**Rotation angle <E>:** press Enter

Text: *Surveyor's Certification*

Text: press spacebar, then press Enter

Text: *I do hereby certify that the survey shown hereon is a true and correct representation...*

Text: press spacebar, then press Enter

Text: ________________________________

Text: *Arnold James, PLS #2534*

Text: press Enter twice to end

The following is a closeup of the certification, north arrow, and bar scale that we just entered:

![Certification Closeup Diagram]

9 Enlarge the two title lines ("Farmer Survey" and "Surveyor's Certification") by a factor of 2.0 using the command Text Enlarge/Reduce on the Edit menu, option Text. When prompted for Scaling Multiplier, enter 2. Select both the Farmer Survey text (at the top of the screen, not in the title block) and the Surveyor's Certification text. When asked again to Select Objects, press Enter.

When you are selecting objects, if you select something you don't want, you can enter "R" at the next Select Objects prompt, and remove items from the selection set. If you want to add objects after you have removed an object, enter "A" at the next Select Objects prompt.
10 Make the enlarged Farmer Survey text at the top of the screen bold by changing its font to the *ITALIC* font. From the Edit menu, select Text then select the Change Text Font option.

**Select Objects:** *pick the Farmer Survey Text at the top of the drawing*

**Select Objects:** *press Enter for no more selections*

**Style Name:** *ITALIC*

11 Select the Edit Text command (under the Edit menu, Text option) to change.

S 00d00'00" E to S 00d E. When you are prompted, "Select Text to Edit:" pick the due South bearing text.

The degree symbol is represented as %%d. (If you had typed N 15%%d25'35" E in the Dtext command, Carlson would draw that entry as N15d25'35"E.) Click in the text to the immediate right of the quotation mark and press the Backspace key until the text reads "S 00%%d E.

Click OK. Press Enter to exit the command.

12 Examine the figure shown in Step 8. Notice how the linework travels into the circle that represents point 5. To clip off the linework at the edge of the corner symbols, use the Trim by Point Symbol command on the Points menu, Point Utilities. This command requires that all points be in view, so if you cannot see your entire drawing, use the Extents command on the View menu (sometimes referred to as Zoom Extents). Respond to the following prompts:

**Select Carlson Software point symbols to trim against.**

**Select objects:** *ALL*

Entering "all" at the command line selects everything on the screen. Only the linework crossing into the corner symbols will be trimmed.

**Select objects:** *press Enter*

You can continue to select objects until you press Enter.

The trimming is completed.

13 Prepare for area labeling by selecting the Area Defaults command on the Area/Layout menu. The dialog box shown below appears.

![Area Defaults dialog box](image)

Select the *Sq. Feet* item and click on the Edit button and make the Area Text Size Scaler 0.2 (doubled from the...
default of 0.1). Click OK when complete. Select the Acres item and click on the Edit button. Change the Other Area Labels and Inverse with Area decimal precision to 4 decimal places. Also, make the Area Text Size Scaler 0.2 (doubled from the default of 0.1) as shown below:

You are going to compute the area by point number. You could have chosen the Area by Lines & Arcs command. In that command, you would pick the lines and arcs that make up the figure. But since the closure was 0.017 off (the distance from point 7 to point 1), you would exceed the default Max gap tolerance. Unless you change that tolerance in this dialog box to something larger than 0.017, you would get no result using the Area by Lines & Arcs command. So do not change it for this exercise because you might forget to change it back. Instead, you will compute the area by inversing from 1 through 7 and back to 1. Click OK to exit the Area Defaults dialog box.

14 Select Inverse with Area on the Area/Layout menu. Respond to the prompts as shown below:

Station/<Pick Starting point or point number>: 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 2
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 3
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): R
Radius point number or pick point: CEN for center "snap"
Now move the cursor, without picking, to the arc and see how the center snap becomes active. When the radius point is found, pick on the arc.

Curve direction [Left/<Right>]? press Enter for the Right option
Pick End of Arc or point number (U-Undo, Enter to end): 4
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 5
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 6
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 7
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): press Enter to end

A Standard Report Viewer dialog box showing the Inverse with Area results will appear. Select Exit at the top of the dialog box and respond to the prompts as shown below:

SQ. FEET: 83921.8 SQ. YARDS: 9324.6 SQ. MILES: 0.0
ACRES: 1.9266 PERIMETER: 1129.0

Pick area label centering point (Enter for none): pick a point near the center of the figure, in its interior.
The area units you chose in Area Defaults are labeled on the screen.

Erase Polyline [<Yes>/No]: Y
This erases a polyline that has been drawn over the original lines and arcs. The Inverse with Area command draws this polyline because often you are solving the area from points and want the new linework drawn.

You snapped to the radius point using the "cen" snap. Additional object snaps appear under Aperture-Object Snap command on the Settings menu. Since all plotted points have a node, you could have inversed around this figure by using the "nod" snap for points 1 through 7, and the "cen" snap to capture the radius point. Snaps are typically entered at the keyboard as 3 characters (for example, "int" for intersect and "end" for endpoint).

15 Freeze the point numbers to finish the drawing by choosing Layer Control on the View menu. In the PNTNO row, click the sun icon to change it to a snowflake icon, which freezes the PNTNO layer. Click OK. The point numbers remain in the drawing, waiting to be "thawed", but they are not displayed.
The final drawing is shown here:
This completes the Lesson 1 tutorial: Entering a Deed.

**Lesson 2: Making a Plat**

In this lesson you will draw out a plat of a single lot, using Carlson drafting techniques. You will make the plat from an ASCII file of points named Plat.txt.

1. Click the icon for Carlson. You may be presented with a Startup Wizard dialog box, as shown below:
You will use the Wizard in Lesson 3 to perform a series of commands to begin a drawing. In this lesson, however, you will enter the commands individually, so that you can see what each one does.

If you see the Startup Wizard dialog box, and you don't want to see it again, click the Skip Startup Wizard Next Time option in the dialog box above. Make sure the other settings are as shown above and click Exit.

Another way to turn off the Wizard is to click it off within the Configure > General Settings command, found under the Settings menu. You will open this General Settings dialog box now.

2 On the Settings menu, click Carlson Configure to display the following menu:

Click General Settings to display the dialog box shown here.
The settings in this dialog box, along with the settings in other Configure sub-options, determine default working conditions for Carlson. Turn on Group Point Entities, which groups point elevations, numbers, and descriptions (all aspects of the points) into a single entity for moving, erasing and other commands.

Choose Numeric Only to store points in numeric form. This produces point numbers such as 1, 2, 3, 10 and 11. If you selected Alphanumeric, then you could have point numbers like 1A, 1B, 1C, HUB5, CTRL, SS10, etc. There is a slight speed advantage to working with purely numeric point numbers. The highest numeric point number allowed is 99999. Regardless of format, point numbers are stored in a file that has a .crd extension. There is no limit to the number of points in an alphanumeric coordinate file. In anticipation of Lesson 3, click on the Use Startup Wizard option. Click OK at the bottom of this dialog box.

Now we want to set the data path. Another of the Configure sub-options is Project/Data Folders. Click this option and you will see this dialog box.

Chapter 17. Tutorials
For this lesson, you will keep it simple. Click on Fixed Folder at the top. Notice the Current Data Folder section at the bottom. This specifies where data files, such as .crd files in this case, are to be stored. Set the folder to C:\Carlson Projects\. Click OK. You are now back to the Configure main dialog.

3 Select Drawing Setup from the Configure main dialog box.

3 The scale acts as a multiplier on all text annotation. For example, 100 * Text Plot Size (0.08) = 8 (text height of 8 units). The Text Plot Size is the effective height, in inches, that the text will appear when plotted at the Horizontal Scale (here 100).

Bearings and Distances, Legends, Title Blocks, and Point Symbols will size up or down on the basis of the Horizontal Scale set within Drawing Setup. Set the Horizontal Scale to 25. Then click OK to exit Drawing Setup. Then click Exit to close the Configure dialog box.

If prompted for Drawing Setup Change, click on the Current and Future button.

If you have not already saved your drawing, now is a good time to do it. Use the Save command on the File menu, and call the file Lesson2.dwg.

4 Next, you will import the ASCII file called Plat.txt and store the points in a Coordinate file called Plat.crd. However, since you are in a new drawing, you have not yet set a coordinate file to store the points in. You must have a Carlson coordinate file (.crd) open and established as the container for your points.

So, under the Points menu, select the command Set CooRDinate File to display a dialog box. Click the New tab, as shown here. To the right of File name enter Plat and click Open. You have now created the required .crd file.
You are now ready to import the points. This time, under the Points menu, select Import Text/ASCII File to display the Text/ASCII File Format dialog box, as shown below. Click the Select Text/ASCII Files button and then choose Plat.txt listed on the right. It is found in the default data folder (C:\Carlson Projects). Click Open.

Plat.txt is an ASCII file containing 54 points in the form of Point Number, Northing, Easting, Elevation and Description. The format of the points appears in the Preview Window. The format is: Point (P), Northing (Y), Easting (X), Elevation (Z), Description (D), or, in short, P,Y,X,Z,D. You must match this format in the Coordinate Order. If you don't see P,Y,X,Z,D in the Coordinate Order box, then select that format from the Common Formats option. Or, you can type the list directly into the Coordinate Order box. Make sure that Draw Points is set to Off.

Click OK. The points will be saved and stored in Plat.crd. A confirming dialog appears as follows:
Click OK.

5 Choose the List Points command under the Points menu.

The List Points dialog box will typically default to the full range of points (ALL), which is 1 through 54 in this exercise. You can control the decimal places for the Northing/Easting and the Elevation of the points in the lower portion of the dialog box. Click OK and the settings shown above result in the report exhibited below in the Standard Report Viewer:
Exit the report by selecting the Exit icon at the top of this report viewer box, or by clicking the X in the upper right of the window.

6 Select the *Draw-Locate Points* command on the Points menu to draw the points on the screen.

Enable the *Descriptions* option as shown above. Also in the figure shown above, the current Symbol Name is showing as SPT10, which stands for Survey Point symbol 10. SPT10 is an X, shown in the symbol display window. You can select a different default symbol using the *Point Defaults* command on the Points menu.

In this exercise you will change the Symbol Name to null, or symbol 0, listed as SPT0 (in effect, no symbol). Later, you will add official property corner and utility symbols. Although you are working without a default symbol, there will always be a "dot" or a node at the correct insertion point of each point number.

At the top click Select. You will see the following dialog box:
Note that the scroll bar at the right of this Select Symbol dialog box leads to more pages of symbols. Click the blank SPT0 point symbol option.

When you select a symbol, you automatically return to the Draw-Locate Point dialog box. Click Draw All and the following dialog will display. The Avoid Point Attribute Overlap dialog uses different adjustment methods, such as moving attributes and creating leader lines, to fix conflicts with the point labels. Pick Cancel for now so we can view these conflicts.

Here you have the rather busy drawing shown below:
You will now be using the *Resize Point Attributes* command on the Points menu. Notice how the lower-right corner of the drawing is very congested, with many overlapping point attributes. You can specify a window containing these points and scale them down by a factor of 0.4. For Scaling Multiplier, you will enter 0.4. When you are prompted to Select Carlson Software points, you will enter WP for Window Polygon and make a polygon around the congested area. Press Enter when you have surrounded the points with the polygon as shown below. Here is the command line sequence, along with the responses you will enter, after clicking *Scale Point Attributes*:

**Method for resizing [<Scale>/Absolute]?:** *Scale*

**Scaling Multiplier <0.500>::** *0.4*

**Scale symbols only, point labels only or both [Symbols/Labels/<Both>]?:** press Enter

**Select points from screen, group or by point number [<Screen>/Group/Number]?:** press Enter

**Select Carlson Software points.**

**Select objects:** *wp*

**First polygon point:** *start creating your polygon*

Once this polygon is complete, you are again prompted to select objects. Press Enter. The following shows the
Next, you will prepare for drawing linework by setting the current layer. You should draft linework and symbol work in designated layers. In this example, you will put linework and symbol work in a layer named Final. (You could put property linework in the Final layer and utility linework in the Utility layer, but, for now, you will put all linework and symbols in the layer Final.) To pick the current working layer, select the Layer Control command from the View menu.

Click Final. Click Current. Click OK.

The 2D Polyline command allows you to enter point numbers to draw a line. First, connect portions of the property line. Select the 2D Polyline command on the Draw menu. A dialog box might appear. If it does, accept the defaults and click OK.
Pick point or point numbers: 1
Pick point or point numbers: 8
Press Enter

This creates a polyline. Keep this as a separate polyline because later you will turn this back lot line into a fence line. Now, connect some of the other property lines. Repeat the 2D Polyline command. You can press Enter to repeat the command, or you can select it from the Draw menu. Connect points 8 through 10, and start an arc, by entering as follows:

Pick point or point numbers: 8-10
Pick point or point numbers: a
Radius pt/radius Length/Arc length/Chord/Second pt/Undo: 15
Pick point or point numbers: 1
Press Enter to end the command

This creates the full lot, with the arc coming off point 10 on a tangent. The line from 15 to 1 is not guaranteed to be tangent to the previous arc.

You should have the following linework at this point:
You will now create a fence line on the polyline you drew from points 1 to 8.

Now, choose the Line Types command on the Annotate menu and select the Change Polyline Linetype command. The Line Types command creates polylines that respond as one entity when selected. When the dialog box appears, click Next twice to display the dialog box shown below.

Choose the Fence_S option (the solid fence line).

When prompted to Select Objects, pick the polyline you created from points 1 to 8. Press Enter to end selection.
Notice in the dialog box above that the current Line Type Scaler, governing spacing, should be 0.5 (inches) and the Text (height) Scaler is 0.1. If your settings are different, you may want to Undo (by entering U for undo) the fence line and select the Annotate Defaults command on the Annotate menu, and set these items to match the example.

On the View menu, select the Isolate Layers command, pick the property line, and press Enter. Here is the result:

Next, you will connect up the edge of pavement. On the View menu, select the Restore Layers command to restore your points. Then select the 2D Polyline command under the Draw menu. Again, a dialog box might appear as shown below. If it does, make sure that the options selected are the same. In the future you can choose not to see this box.
Click OK. Proceed as follows to connect up the edge of pavement:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 45-47,49-51
Press Enter at the next prompt to exit the command and create the road. Press Enter one more time. Note how you can separate range entries using a comma.

12 To smooth the edge of the road, select the Polyline Utilities command on the Edit menu, and select Smooth Polylines.

Enter the looping factor (1-10) <5>: press Enter
Enter the offset cutoff <0.05>: press Enter
Reduce polylines before smoothing [Yes/<No>]? press Enter
Select polylines to smooth.
Select objects: pick the edge of road polyline
Select objects: press Enter

13 To offset the smoothed edge-of-road polyline by 24 feet to make the opposite edge of the road, Select the Offset > Standard Offset command on the Edit menu.

Specify offset distance or [Through/Erase/Layer] <Through>: 24
Select object to offset or [Exit/Undo] <Exit>: pick the edge-of-road polyline
Specify point on side to offset or [Exit/Multiple/Undo] <Exit>: pick to the right of the polyline
Select object to offset or [Exit/Undo] <Exit>: press Enter to end the command

Now, select the Isolate Layers command again from the View menu, pick on any of your linework, and only the entities on the picked layers are displayed.

Select the Restore Layers command from the View menu to recover your points. Experiment with the "cadence" of Isolate and Restore Layers. Select Isolate Layers, pick the layers to isolate, and then press Enter twice. Then select Restore Layers.

14 Next, you will draw the shed. Select the 2D Polyline command on the Draw menu. To draw a two-sided shed, connect points 5 through 7 as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 5-7 press Enter twice
This produces the 2-sided building shown here:
Select the 4 Sided Building command on the Survey menu. Turn the 2-sided shed into a 4-sided shed as follows:

**Options/<Pick a line or polyline>: Pick the shed**

Now your 2-sided building looks like this:

---

15 Focus your attention on the area of tightly spaced points with point numbers ranging from 27 to 44. This is the driveway and paving area. In the case of the driveway, assume that the surveyor who collected the points shot in 3-point arcs. They came up to a PC, shot a point on the arc, and finished up at the PT.

On the View menu, select the Window option, and pick a lower left and upper right point that windows the driveway area. If you wish to use the View > Previous command to zoom out, then use View > Window to zoom in again.

Select the 2D Polyline command under the Draw menu, and walk the polyline through the two arcs as follows:

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
[Arc/Close/Distance/Extend/Undo/<Pick point or point numbers>]: 28
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: A
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: S
Second point or point number: 29
Endpoint or point number: 30
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: A
Second point or point number: 32
Endpoint or point number: 33
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: press Enter
```

In the above exercise you started at point 27, went to the PC at point 28 and inserted a 3-point arc through points 29 and 30. You proceeded on a tangent direction to point 31, which was another PC, then completed a 3-point arc through points 32 and 33, and ended. Now, connect up the basketball court area. Select the 2D Polyline command under Draw, or press Enter to repeat the previous command.

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 27
```

---

Chapter 17. Tutorials
Next you will make a building footprint. Points 18 and 19 are two shot corners of a building. Assume that the surveyors taped the main house, going clockwise from point 18, as follows: 10'L, 20'R, 40'L, 20'R, 20'L, 83'L, 60'L, 23'L, 10'R.

You can easily enter these "jogs" in the building using the Extend by Distance command. If you are zoomed in on the driveway, use View > Zoom > Zoom Out, and then View > Pan to focus on the building north of the driveway. Now use the 2D Polyline command on the Draw menu to draw a line from 18 to 19.

**Pick point or point numbers:** 18

**Undo/Arc/Length/<Pick point or point numbers>:** 19, then press Enter twice to end

From the Edit menu, select the Extend > By Distance command.

**Pick line or pline to extend:** pick the building line closer to point 18

This makes the arrow point toward 18 rather than 19. Now you can go clockwise:

**Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** L10 (lower case "l" and "r" work also)

**Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** R20

**Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** L40
Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): C to close the figure

17 Next, you will complete the linework for the sewer line and the electric utility line. Use the View > Extents command so you can see all your points.

The sewer line runs from points 52 to 53 to 54. Select the 2D Polyline command from the Draw menu. To create the sewer line, enter the following:

[Continue/Extend/Follow/Options/<Pick point or point numbers>:] 52-54, press Enter twice to end

You will next annotate the sewer polyline using the Change Polyl ine Linetype command, but first you must set the default spacing for the annotation. Select the Annotate Defaults command on the Annotate menu. The following dialog box appears.

![Annotate Defaults dialog box]

Change the Line Type Spacing to 1.5 and click OK. This will label "S" on the sewer line every 1.5" at the current scale (1"=50').

To annotate the sewer line with an S, select the Line Types command on the Annotate menu, and then choose Change Polyline Linetype. Within the dialog box, click Next twice, select the Sewer linetype from the list, and then select the sewer polyline that runs next to the road. The polyline will be annotated.

Next, create the electric utility line, which runs from point 3 to point 4 to point 17. Select the 2D Polyline command on the Draw menu.

[Continue/Extend/Follow/Options/<Pick point or point numbers>:] 3
[Arc/C lose/Distance/Extend/Undo/<Pick point or point numbers>:] 4
[Arc/C lose/Distance/Extend/Undo/Line/Undo/<Pick point or point numbers>:] 17
[Arc/C lose/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>:] press Enter twice to end

No points were taken beyond point 17, due to obstructions from the various setups in the field. So you must extend
the polyline from point 17 to beyond the property. Under the Edit menu, choose Extend, then By Distance. Pick on the electric utility polyline near point 17. Then pick beyond the property. Press Enter to end.

Before you annotate the electric utility line, you must offset it 25' on both sides, for a 50' total right-of-way. You will do this using Standard Offset. Select the Offset > Standard Offset command under the Edit menu. Enter the offset distance of 25. Pick the electric utility polyline and then pick to one side for the first offset. Repeat for the other side, by first picking the electric utility polyline, then picking the other side for the offset. Press Enter to end.

Now annotate the central electric line with an E by selecting the Line Types command on the Annotate menu, and then choose Polyline to Special Line. Choose the Electric linetype, which appears on the third page of linetypes. Then select the electric utility polyline to annotate it, and press Enter.

18 Next, make the Property lines bold. Under the Edit menu select Polyline Utilities > Edit Polyline and then select Change Polyline Width.

**New Width <0.0>: 1.5**

**Select objects:** Pick once for the fence line portion and once for the remaining property lines.

**Select objects:** press Enter to end

19 To add color and improve layer management, make a layer for your road and driveway. Select the Layer Control command on the View menu.

Click the New Layer button, and enter the name "Road" for the new layer. Choose the color Cyan by clicking the color square to the right of the layer name. Click OK.

On the View menu, select the Change Layer command.

**Select entities to be changed.**

**Select objects:** Pick all driveway and road entities and press Enter

**Specify new layer [Name/<pick entity>]: N**

This brings up the dialog box shown below. Select ROAD and click OK.

Your linework is now complete and is shown below:
You will add symbols for trees, property corners, manholes and a light pole.

Start with the trees. Points 11, 12, and 20 are oak trees of different sizes, and point 14 is a pine tree. Use symbol 61 for the deciduous oak trees and symbol 53 for the pine tree. On the Draw menu select the Symbols > Insert Symbols command. The following dialog box appears.

Click the Select button, and within the Select Symbol dialog box, use the down arrow at the right to scroll forward to the tree symbols, which are several pages deep. Choose symbol SPT61. You can also choose Trees under the Symbol category field in this dialog. You are returned to the Insert Symbols dialog box.

Set the Erase Existing Symbols option to Yes and then click the Select Layer button and type in TREES in the Layer Name field. This creates a Trees layer if one does not exist. Click OK. For the Symbol Size use 18. A symbol size equal to the diameter of the tree is often effective. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 11
Options/Select entities/Enter Coords/<Pick point or point numbers>: 20
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter
Place symbol 61 on the larger point 12 at size 24. Press Enter to repeat the last command, or once again select the
Insert Symbols command from the Draw > Symbols menu. Symbol 61 will now be the default. Change the Symbol
Size to 24 and click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 12
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 53 on the larger point 14 at size 8. To do this, press Enter to repeat the last command, or select Insert
Symbols from the Draw > Symbols menu. Select symbol 53 and a Symbol Size of 8. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 14
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 5 (representing an iron pin) on points 8-10 and point 15. Repeat Insert Symbols by pressing Enter
to repeat the last command, or again select the Insert Symbols command from the Draw > Symbols menu. Select
symbol 5 (first page) and leave the Symbol Size of 8. Change the layer to FINAL. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 8-10,15
Wildcard match of point description <**>: press Enter

This puts symbols on points 8 through 10, as well as point 15.

Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place a concrete monument (symbol 13) on point 13 on layer FINAL. Keep the Symbol Size of 8. Press Enter to repeat the last command, or select the Insert Symbols command from the Draw > Symbols menu. Select symbol 13.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 13
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place a manhole (symbol 34) on the vertices (endpoints) of the sewer line, at points 52 through 54. You could use the above method, but you can also use S for Select entities, and place the symbol automatically at the vertices of the selected entity.

Select the Insert Symbols command from the Draw > Symbols menu. Select symbol 34 from the list. Keep with layer FINAL and Symbol Size 8. Click OK.

Options/Select entities/Enter Coords/<Pick point of point numbers>: S

The following dialog box appears. Click OK.

Select arcs, circles, faces, points, text, lines and polylines.
Select objects: pick the sewer polyline

The symbols are inserted at the three polyline endpoints.
You can reduce clutter by selecting the Freeze Layer command under the View menu, and picking a point number. The points freeze, leaving only linework and symbols. To bring the points back, use the Thaw Layer command under the View menu. The Freeze Layer and Thaw Layer commands go together, just like the Isolate and Restore Layers commands.

Next, you will create (in reduced size) your building dimensions. You can set the building dimension text size for the current work session using the Survey Text Defaults option of the Survey Text command on the Annotate menu. This dialog box appears:

The changes you will make are in the upper-left section "Building Dimensions." Change the Text Size Scaler to 0.04, select Drop Trailing Zeros and change Offset From Line to 0.02.

The Drop Trailing Zeros option will label 17.0' as 17'. To save more space, you could blank the Characters to Append box, but not this time. Enter the name of a new layer for the building text called BTXT, so that building dimensions can be frozen to reduce the clutter even more. It is generally a good strategy to use layers for selective freezing and thawing.

Click OK on the above dialog box. On the Annotate menu, choose the Survey Text > Building Dimensions command. Click on the middle of the bottom segment of the building and then drag the alignment to the right, along the same bottom segment being dimensioned. The resulting label is shown below.
If you had dragged the cursor to the left rather than to the right, with the same near-parallel angle to the line, the 83’ would be drawn below the building rather than above.

Another example is shown below. Select Annotate > Survey Text > Building Dimensions, and click on the left-most segment of the building. Then click roughly perpendicular to the left. This creates a perpendicular, rather than parallel, label as shown below.

Label the rest of the building. Notice that the sides of the building that you are dimensioning are measured in even feet. Because you had selected the Drop Trailing Zeros option when you set your Survey Text Defaults, and you set the Decimal Places default at 0.0, the ".0" is not reflected in the labels:
If you choose the wrong direction while you are labeling, you can exit the command, or you can erase the incorrect dimension by typing E for erase at the command line, or you can enter U for undo to back out your last work. Once the labels are in place, you can type M for the Move command, and move the text to the desired position.

Next, you will label the offset dimension from property lines to two building corners, the SE corner as offset from the south property line, and the SW corner as offset from the west property line. Because of the options you set in the Survey Text Defaults dialog box above, Offset Dimensions will be created on layer DIMENTXT, and they will be horizontal, with arrowheads.

On the Annotate menu select Survey Text > Survey Text Defaults. The dialog previously shown will reappear. Change the Text Size and Arrow Size Scalers to 0.040. Then select Dual Arrows Line and click OK. On the Annotate menu, select the Survey Text > Offset Dimensions command.

Pick Bldg/Object Corner: pick on the SE building corner
Pick Line To Offset From: pick on the South property line (before the arc, near the end of the driveway)

The setback is labeled 43.5'. Note the distance suffix is/was labeled as an apostrophe "'" rather than ft. If you desire an alternate label, re-examine the Characters to Append control of the Survey Text Defaults command.

On the Annotate menu, select Survey Text > Survey Text Defaults. Under Offset Dimension Text change the Text Alignment to Parallel instead of Horizontal. Click OK. Select Annotate > Survey Text > Offset Dimensions command.

Pick Bldg/Object Corner: pick on the SW building corner
Pick Line To Offset From: pick on the West property line (avoid the electric right-of-way line)

Use the Move command to move the 20' text label to the right, so that it is not overwritten by the offset dimension. The result is shown below:
Notice the display, within the above prompts, of the [end on] and [perp] snaps. When Carlson sets a snap for temporary use, it displays the snap within the brackets as shown. A building corner is always an endpoint, so the end snap always applies to the first pick. The offset is the perpendicular distance to the property lines, so the [perp] snap always applies to the second pick. The "per" (perpendicular) snap applies to offsets from arcs as well. In the case of arcs, the "per" snap finds the shortest, radial distance to the arc.

When you enter a snap at the keyboard in response to a "Pick object" request, type only the first 3 letters of the snap, such as "per" or "end". You could use the Offset Dimension command to label the Electric utility right-of-way distance of 50’ total by entering "nea" (for nearest snap) for the first pick, then entering the default "per" snap for the second pick on the other side of the right-of-way.

24 Next, you will add adjoiner ownership text to the property lines. Select the Survey Text Defaults command, under the Annotate menu, and set the Adjoiner Text Justification option to C for centered, and the Text Size Scaler to 0.06. Click OK and then select the Adjoiner Text command on the Annotate > Survey Text menu.

**Pick Line Or Polyline:** *pick the west property line*

**Pick Starting Point:** *pick a centering point west of the property for the adjoiner text*

**Text:** Brian W. and Mary T. Jones

**Text:** D.B. 101, P. 37

**Text:** press Enter twice

This produces parallel, center-justified text on the west side of the property. Repeat the command for the north side. Press Enter to repeat the Adjoiner Text command or select it from the menus.

**Pick Line Or Polyline:** *pick the north property line*

**Pick Starting Point:** *pick a centering point north of the north property line*

**Text:** Stan W. Bosworth

**Text:** D.B. 94, P. 272

**Text:** press Enter twice

The results are shown here:
Next, you will add bearing annotation. Select the Annotate menu, choose Angle/Distance, select the BearingDistance option to place Bearing and Distance above the line.

Define bearing or set text size [Size/Points/<select line or polyline>]: pick the northern property line to the east, or right side

The bearing direction will be labeled towards the picked end, which is northeast.

Define bearing or set text size [Size/Points/<select line or polyline>]: pick the eastern property line closest to the southern endpoint of the line

To label the western property line on the lower (western) side of the line, select the BearingDistance command on the Angle/Distance menu.

Define bearing or set text size [Size/Points/<select line or polyline>]: pick the western property line on the northern portion of the line

To label the southern line segment with a leader, on the Annotate menu select the Annotate with Leader > Brg-Dist with Leader command.

Options/Size/Points/<Select line or polyline>: pick the southern property line segment on the southwest side
Pick point to start leader: pick a point to start and locate the pointed end of the arrowhead
Label Position: pick a point for the label position
Options/Size/Points/<Select line or polyline>: press Enter to end

Next, you will want to annotate the arc in the drawing. The label will consist of four entries: arc length, radius, chord bearing (direction) and chord distance.

From the Annotate menu, select the Annotate Arc > Stack Label Arc command. The Stack Label Arc dialog box appears.
Set the sequence column to 1, 2, 3 and 4 as shown. When you are done with the dialog box, click OK.

**Curve Info [Options/Points/<select arc or polyline>]**: pick the arc

**Pick point for labels**: pick a point to the right to place the label

As the cursor moves, the text "ghosts", allowing you to make the best possible placement decision

**Pick point to start leader at ([Enter] for none)**: pick a point on or near the arc for the arrowhead

**To point**: pick a point near the labels

**Curve Info [Options/Points/<select arc or polyline>]**: press Enter to end

If your arcs/curves appear as "chorded" segments, type REGEN at the command prompt to "regenerate" the arc. Even if an arc shows up on the screen as a group of jagged chords, it will plot as a smooth arc to a printer or plotter.

27 Next, you will label the trees, the shed, and the building using a special leader, for a hand-drafted appearance. Under the Draw menu, select the Leader > Special Leader command.

**Options/Size/Pick Arrow Location**: pick near the southern most corner of the shed

**Text location**: pick slightly down and to the right

**Text**: Shed

**Text**: press Enter twice to end

Repeat the process for all the special leader text items shown in the drawing below. In the case of the 18" Oak trees, create just one leader with text and on the second oak tree, create only the leader and then press Enter when asked for Text. For the best appearance, enter 18"Oak and 24"Oak with no spaces between the characters.

Your drawing should be similar to this one:
28 You can add a North Arrow and Bar Scale by selecting these options under the Annotate menu. When you place the North Arrow, pick your North Arrow symbol, maybe change the scale, and click OK. Then pick an insertion point. You place the Bar Scale by answering the prompts and picking a location. Both the North Arrow and the Bar Scale can be moved to desired locations with the Move command on the Edit menu.

29 Next, you will insert a title block with a border. Select the *Title Block* command from the Settings menu.

Choose paper size A1 (portrait view, 8-1/2 by 11). Click OK. Pick a point below and to the left of the survey in order to locate the lower-left corner of the border outer line. Remember that the title block will be at the bottom, so leave extra room at the bottom.

The following dialog appears, prompting you for the attributes of the title block. Be sure to also click Next in order to enter in more attributes.
Your drawing should resemble the one shown below.

30 Next, you will add a legend. On the Annotate menu, select the Draw Legend command. Choose the New tab, and then Open the default legend name. When the dialog box appears, select Add from Drawing. You will make one pick for each symbol you want to appear in the legend. Select one of the sewer manholes, one of the iron pins, the concrete monument, one oak tree and the pine tree. Press enter. You will then see the symbols that you picked listed.

If you want to change the order of the items in the list, use the Move Up and Move Down buttons, after first selecting
and highlighting the item to be moved. After the list is ordered correctly, highlight one item on the list and click the Edit button to edit the symbol definition.

Edit each symbol definition individually and type the following descriptions in the description box:

SPT5 = "Iron Pin"
SPT34 = "Manhole"
SPT13 = "Concrete Monument"
SPT61 = "Oak Tree"
SPT53 = "Pine Tree"

Below is the symbol definition, with Description, for SPT13.

After you have entered the descriptions for the symbols, choose the Add option from the Legend Definition dialog box and add the Fence Line type to the list by picking the Select Library Linetype command, as shown below:
Save the completed legend which is shown below.

Select the Draw option from the Legend Definitions dialog box. Set the defaults as shown below.
Click OK. Pick a point for the legend at a coordinate location approximately at 5260,4380. Then click Exit.

You may need to move the fence line portion of the legend to fit in the tight space. You also may need to move the previously drawn bar scale. Use the Move command to do this. The following shows the drawing to this point:

If you wish to reset the spacing of the sewer and electric utility annotation, use the LTSCALE box in the Drawing Setup dialog box found under the Settings menu. (The setting is 50 in this example).

Next, you will use Dtext to label the road and Mtext to create a certification block. Zoom in on the area shown below. At the command line, type Dtext.

Specify start point of text or [Justify/Style]: R (for right-justified)
Specify right endpoint of text baseline: pick a point as shown below, just to the left of the leader annotation
Specify height <8.00>: 10
Specify rotation angle of text <E>: pick a point as shown below by the location of the crosshair

Text: Meadow Lane
Text: press Enter

This right-justifies the label Meadow Lane, ending it before it contacts the leader line.

Now you will enter a certification using Mtext. The Mtext command stretches an entire block of text. This command breaks up the lines in the block of text depending on how you edit and adjust the Mtext window. First, use the View > Extents command to view the entire drawing. Then type Mtext at the command line.

Specify first corner: pick a point in the 5660,4980 range
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: pick a point below and to the right of the first, but inside the inside border line

You now see a dialog box that displays all the text heights that you have used in the drawing. Choose the text height of 8. Then type the following into the dialog box:

![Text Formatting dialog box]

Surveyor’s Certification
I do hereby certify that the survey shown hereon was performed under my direction by method of random traverse, and that the error of closure was 1:52544

3 Brad Smith PLS No 11952

The command "wraps" the text when it runs out of space in the Mtext window. Click OK at the upper right to place this text into the drawing.

After the Mtext is plotted, you can click on the text to activate the grips. All 4 corners highlight as grips. When you pick on a grip, you can expand or change the shape of the Mtext rectangle. When you do this the text adjusts automatically, wrapping into more or fewer lines of text based on the size of the MText window. You can also move the entire text block to a new location.

Next, you will define a text style and then add text using that style. On the Draw Menu, choose the Text > Set Style command. The Text Style dialog box appears. Click New, enter Bold in the New Text Style dialog, and click
Create a **Bold Style** consisting of the Arial Black font tilted at a 10° oblique angle, by entering the settings as shown below.

[Image of New Text Style dialog box]

Then click Apply and Close. Now, run the Dtext command by typing Dtext at the command line, and place the text at the top of the drawing as follows:

**Specify start point of text or [Justify/Style]:** pick a point near the northwest corner of the drawing  
**Specify height <10.00>:** 20  
**Specify rotation angle of text <N 54d40'16' E>:** E for due East  
**Text:** William T. Farmer  
**Text:** press Enter twice

33 Next, you will create an area label for the drawing. Select the Area Defaults command, under the Area/Layout menu, and change the Precision for the Acres labels to 2 decimal places.

Select the **Area by Lines & Arcs** command, under the Area/Layout menu. When prompted to Select objects, pick the 2 polylines that taken together, completely enclose the property.

Pick an area labeling centering point for the area label under the William T. Farmer title at the top of the drawing.

34 Next, bring the points back and draw a contour map. To draw the points, use the **Thaw Layer** command under the View menu. If you did not complete this lesson in one sitting, then Carlson won't "remember" what layer to thaw. In that case, select the **Layer Control** command on the View menu, and thaw the PNTS layer by turning the snowflake to a sun symbol.

Go to the Surface menu and select the **Triangulate & Contour** command. Click the Contour tab.
In this Contour tab section, change the contour interval to 1.0. Now click on the Triangulate tab, and then click on Use Inclusion/Exclusion Areas. Press OK and then answer as follows:

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: press Enter
We have no "inclusion" perimeter.

Select the Exclusion perimeter polylines or ENTER for none.
Select objects: select the building and the shed, and then press Enter
Since the building and shed are closed polygons acting as exclusion perimeters, the contours will not pass through them when they are created.

Select the points and breaklines to Triangulate.
Select objects: type ALL and then press Enter twice

The contour map is created. Freeze the points again by using View > Freeze Layer and picking one of the points.

Next, label the contours. From the Surface menu, select the Contour Utilities > Contour Elevation Label. Select OK after matching the settings in the dialog box shown here:
Now pick two points that cross through one or more contours. The contours are automatically labeled using the current text style. You can use the Change Text Font command, part of the Text command in the Edit menu, to change the font to Romans, or to another font, if you wish to.

The Completed Plat is shown here:

If you have not saved your drawing for awhile, now is a good time to do it. Use the Save command on the File menu.

This completes the Lesson 2 tutorial: Making a Plat.
Lesson 3: Field to Finish for Faster Drafting

In this lesson, you will make a plat using field to finish techniques, with the help of the Startup Drawing Wizard.

1 Launch Carlson, or, if you are already in the program, select the File menu, and select New to start a new drawing. Save your existing drawing first, if you'd prefer. If you are asked to use a template, choose carlsonxx.dwt, where xx is the last two digits of the AutoCAD release that you are working with. For example, for AutoCAD 2008, you would select carlson08.dwt.

The first of several Startup Wizard dialog boxes appears. If the Startup Wizard does not appear, then go to the Settings menu, choose Configure and then select General Settings. In the General Settings dialog, click Use Startup Wizard in the upper-left and click OK. Then open a new drawing again.

Once in the Startup Drawing Wizard, click Set at the top of the dialog box, and enter in a new Drawing Name. Since this is Lesson 3, call the new drawing Plat3.

Verify that the other settings match the settings shown above, and click Next. You will see the Startup Wizard Data Files dialog. This dialog box is used to specify where to store data, and the existing point information source. Click the Set button to establish Plat3.crd as the new CRD file name.

Our source is the same file as in Lesson 2, Plat.txt. This is an ASCII file, so select Text/ASCII File for the source of our Point data and click Next. The Import Text/ASCII File dialog box appears. Click the Set button to establish Plat3.crd as the new CRD file name.

In the next dialog box, titled Text File to Read, choose plat.txt from the "Carlson Projects" folder, and then click Open.
The Text/ASCII File Format dialog appears again, and the format of the points appears in the Preview Window, for verification, as shown below. Be sure that to the right of Draw Point, that Draw-Locate Pts is selected. Set the other options as shown. Click OK.

The points are then copied into the file Plat3.crd. If you repeat this exercise, and again use the file name Plat3.crd, you will be asked:

[O]verwrite w/new coordinates, overwrite [A]ll, or use number <55>: A (for all)

In either case, when you correctly complete the process, the following dialog box appears:
Then this Drawing Import Wizard dialog box appears:

Choose the Field to Finish option, and click Next. If you receive a file selection dialog titled Specify Field Code Definition File, choose the file called "Carlson.fld". A dialog box now appears with a warning that some codes have two descriptions.
The command is asking whether these codes are to be treated as two separate descriptions, or as one description that has a space in it. Choose the default (Split all multiple codes) to tell the command that codes with spaces are really two separate descriptions, and click OK.

The Draw Field to Finish dialog box appears. Choose the options as shown here. Then click Additional Draw Options.

This displays a dialog box that provides many additional options, as shown below.
You want to draw all 1 through 54. Make sure the other options are set as shown above. Click OK twice.

*Draw Field to Finish* now draws the points and linework. *Draw Field to Finish* saves you many manual steps. Your plat is shown below:

2 To understand how the above drawing was created, select *Draw Field to Finish* from the Survey menu. If you are prompted about Possible Multiple Codes, accept the default *Split all multiple codes* option and click OK. On the *Draw Field to Finish* dialog box, select the Edit Codes/Points button. This takes you to the Field to Finish dialog box.
The display window shows a list of point codes, such as IP for iron pin and FL for fence line, that are converted to special symbols and linetypes by Draw Field to Finish. For an example of how the codes are used, look at the sewer line running from point 52 to 53 to 54 (the southernmost point), which is based on a field code of MH. Select MH for Manhole as shown above, and then click Edit. The following dialog box is displayed.

MH has several attributes that are used by Draw Field to Finish, based on the settings shown above. Draw Field to Finish places the manhole on layer SEWER, and plots a text description of "MANHOLE" underneath the symbol (Descriptions can be upper or lower case). Click on the Symbol tab and notice that it draws a manhole using the symbol SPT34. From the Linetype tab, it draws a sewer line with the letter S for sewer. When you are done looking
at the MH field code definition dialog, click OK.

Other codes have fewer attributes. LP is set only to draw a symbol and text (Light Pole), but not to draw linework. FL, for fence line, is set to draw linework but not corner symbols or points descriptions. A code's attributes depend on the entries in the Set Linetype, Set Symbol, Description and Entity Type options.

The “Carlson.fld” Field to Finish code table is provided with Carlson Software. This table shows one possible system, but with far too many codes for a field crew to remember. You can make your own table by choosing the Code Table Settings option from the Field to Finish dialog box, then choose the Set button at the top right. Then select the New or the Existing tab from the top of the Specify the Code Definition File dialog box, in order to create or select a different code table (.FLD) file.

Click Exit to dismiss the Field to Finish dialog box.

Use the Layer ID command, located under the Inquiry menu to verify the layers of the various plotted entities. Select Layer ID. Pick on the fence line, the road and the utility line, and notice the different layers (FENCE, EOP, UTILITY). You can also use Drawing Inspector under Inquiry to hover over linework to see their layer. You should study the layers in a drawing before deciding what to freeze and thaw. To reduce clutter on the screen, select the Layer Control command from the View menu (the appearance of this dialog box might vary from that shown below).

Freeze the PNTS layer, the SPOT layer, and the PNTELEV layer by turning the sun into a snowflake. To select multiple layers hold Ctrl, Then click OK.

Now you will do some drawing cleanup. Note that a single property line is drawn from point 8 to 9 to 10 and to 15. The chord from point 10 to 15 should be an arc. You will erase the segment from 9 to 10 and from 10 to 15, so that you can re-draw it, establish the tangent, then draw the arc and finish back at point 1.

From the Edit menu, select the Polyline Utilities > Remove Polyline > Remove Polyline Segment command.

Break polyline at removal or keep continuous [<Break>/Continuous]: press Enter for Break
Select polyline segment to remove: Pick the segment from 9 to 10, then the segment from 10 to 15, then press Enter to end

To draw the correct polyline, use the 2D Polyline command under the Draw menu. If you prefer to type in the command, type 2dp which stands for 2D Polyline. If the Polyline 2D Options dialog box appears, accept the default values and click OK.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 9
[Arc/Close/Distance/Options/<Pick point or point numbers>]: 10
[Radius pt/radius Length/Arc length/Chord/Distance/<Pick point or point numbers>]: A
[Radius pt/radius Length/Arc length/Chord/Distance/<Pick point or point numbers>]: 15
[Radius pt/radius Length/Arc length/Chord/Distance/<Pick point or point numbers>]: 1
[Radius pt/radius Length/Arc length/Chord/Distance/<Pick point or point numbers>]: press Enter
Use the 4-Sided Building command (found under the Survey menu) you learned in Lesson 2 to create the other two sides of the shed, located in the upper middle of the screen, near point 17. The end result, except the house, is shown below:

5 Much of the text in the above drawing, such as tree sizes and types, the manhole text, and the light pole text, can be used in the final drawing. But some of the text, such as the text plotted for iron pins and poles, can be fully described in the Legend without the redundancy of plotting to the screen. If you use the Erase command to remove the iron pin and pole text, the entire point will be erased because the attributes are grouped with the point. Instead, use the Erase Point Attributes command under the Points menu.

Select attribute(s) to erase (Enter to end): pick the 3 poles and the 4 iron pins and then press Enter when complete

6 Next, you will use Extend by Distance command to create a building. The building will be less complex than the building you created in Lesson 2, but you will use the "t" and "c" options in addition to "l" for left and "r" for right. From the Edit menu, select the Extend > By Distance command.

Pick line or polyline to extend: pick the western side of the small line segment west of the 12" pine and north of the driveway.

"T" or "t" means "total" distance or "to" the distance - so extend "to" 50 feet total.


In Extend by Distance, the "T" option (for total distance) solves the dilemma of making an existing line of unknown length extend to an exact known length.

7 Use the Twist Screen command to better position the plat on the sheet. Not every drawing can be plotted "due North." Sometimes the plat needs to be oriented so that property lines and important features run nearly left-to-right or top-to-bottom on the plotted page. In this drawing, you want the western line from point 8 to point 9 to run left-to-right on a sheet that will be plotted in landscape style (longer left-to-right than top-to-bottom). Under the
View menu, select the *Twist Screen > Line, Polyline or Text* command.

**Pick a line, polyline or text to make horizontal:** _pick the western line_ from point 8 to point 9, closer to point 9

Now the drawing appears as shown below:

![Image of drawing](image)

Notice that the north indicator (referred to as the USCICON, if shown) at the lower left displays the orientation. The benefit of the *Twist Screen* options are that coordinates of points and directions of lines have not changed. In other words, only the orientation of the data on the screen has changed.

8. Now select *Twist Point Attributes*, under the Points menu, to twist the point descriptions and point numbers back to a left-to-right rotation.

**Twist by** [**<Twist screen>/Azimuth/Entity segment/Follow polyline**]? press Enter

**Enter angle relative to current twist screen <0.0>:** press Enter

**Select points from screen, group or by point number** [**<Screen>/Group/Number**]? press Enter

Select Carlson Software points.

Select objects: *ALL*, and then press Enter twice

The points then twist back orthogonal to the screen, reading once again from left-to-right.

9. The remaining descriptions associated with the points can be used in the final drawing, but they should be moved slightly for a better appearance. For example, the tree descriptions would look better if they were not inside the tree canopies.

Under the Points menu, select *Move Point Attributes - Single*. The steps of the command are:

**Select attribute(s) to move (Enter to end):** _pick an attribute to move_

**Displacement:** _pick the new location for the attribute_

**Rotation:** _pick the new orientation for the attribute_ or press Enter to keep the existing orientation

Then the command repeats. Notice how the text "ghosts" as it moves, which helps you place it in the best position. Try to duplicate this result:
10 Because of the earlier *Twist Screen* command, the E’s in the electric utility polyline are upside down. From the Edit menu, select the *Text > Flip Selected Text* command.

**Select the text to flip.**

**Select objects:** pick the upside down E’s individually and then press Enter (see above image)

11 We wish to apply building dimension labels to the exterior of the building created earlier. From the Annotate menu, select the *Survey Text > Survey Text Defaults* command and set the Exterior option as shown below:

Click OK when complete. From the Annotate menu, select the *Survey Text > Building Dimensions* and pick on the house. If the text overwrites the inside corner of the house, use the *Move* command (under the Edit menu, or type M
for Move at the command prompt) and move the 30' dimension beneath the line.

12 To automatically annotate bearings and distance, as well as arcs, select the Auto Annotate command from the Annotate menu. When the dialog box appears, under the Lines tab, select the options you would like to use so that the bearings and distance labels appear as you would like. Then pick the three polylines that fully define the perimeter: the fence line, the polyline containing the arc, and the lower polyline, which is still the western polyline although you have twisted the screen so that it runs along the lower portion of the drawing. Use the Move command to move the bearing and distance labels to avoid overwriting other features.

When you move the lower distance label, 404.90' to the left, you want to move perfectly level to the screen, since this was the line you used to twist the screen, and it runs perfectly left-to-right. To do this, press the function key F8 to activate Ortho. Then pick 404.90' and move it to the left, picking its final position. Repeat this for the S 17°05'38'' E bearing. After you move these items, press F8 again to turn off Ortho. Sometimes you will load a drawing from another client or source, and the Ortho setting has been left on. This may initially confuse you during the Move commands. Press F8 to deactivate Ortho. Notice that F8 works even with Twist Screen active.

13 Auto Annotate may center the arc annotation above and below the arc, which may cause the arc data to overwrite the surveyed edge-of-pavement (EOP) polyline. As needed, you may want to erase the arc annotation, and use the Annotate > Annotate Arc > Label Arc command to better control the placement of the arc annotation.

If needed, erase selected portions of the arc annotation. At the command line, enter E for Erase.

Select objects: enter WP and then press Enter
First polygon point: pick initial point of a polygon
Specify endpoint of line or [Undo]: pick subsequent points as shown and then press Enter twice when the selection set is complete
There is no "close" option for window polygon and crossing polygon selections.

For the new annotation, under the Annotate menu, select the Annotate Arc command, then the Label Arc option. Then select the arc from the screen. The Label Arc Settings dialog box appears:
You want to locate the arc text inside the arc, on positions 1 and 2. Position (Row) 1 is just under the arc, and 2 is under 1. Be sure they are both Inside. Fill out the dialog box as shown above and click OK.

The new arc text might overwrite the 8’’ Pine, so, if it does, use the command Move Point Attributes - Single, in the Points menu, to relocate the 8’’ Pine description.

With the annotations placed in new positions, your drawing should be similar to the one shown below. Move your annotations to match this drawing.

14 To label the area of the lot, first select the Area Defaults command from the Area/Layout menu. Set Sq. Feet (s.f.) to the nearest whole unit (no decimals) with a Text Size of 0.100 and Acres to 2 decimal places with a Text Size
of 0.100. Then click OK to exit the dialog box. Select the *Area by Lines & Arcs* command from the Area/Layout menu, and pick the three polylines individually that define the property perimeter. Press Enter and locate the text to the left of the 12” Pine.

15 Before completing the final formatting of your drawing, you need to do some minor cleanup, using procedures you learned in Lesson 2.

You don’t want point 16, the PL point, to show in the final drawing. Use the *Drawing Inspector* command, under the Inquiry menu, to verify the layer of point 16, which should be MISC. Freeze MISC using the *Freeze Layer* command on the View menu, and pick point 16. Freeze the point numbers using the *Layer Control* command on the View menu, and freeze the layer PNTNO.

16 To insert an A1, 8-1/2 x 11 border and title block, with the orientation landscape (not portrait), select the *Title Block* command from the Settings menu. You will see this dialog box.
Be sure these above selections match your own. Click OK. For the insertion point, select a point at the very lower-left of the screen, so that your drawing plan entities fit inside the border and somewhat nearer to the top. Pick your screen location. You will then be prompted for the attributes of the title block. Fill them in and click OK.

![Edit Attributes dialog box](image)

If you prefer, you can use the *Move* command, pick the title block and two border perimeters, and move them. Never move the drawing, because you will change the coordinates if you do. Move the drawing only if changing the coordinate locations does not matter.

17 From the Annotate menu, select the *Draw Legend* command. Select the Existing tab and choose the .lgd file that you saved in Lesson 2 and click Open. Then select Draw and OK to close out the dialog boxes that follow, and then click Exit.

Pick an upper-left location point in the available space to the lower-left of the plat. If you did not save a legend in Lesson 2 (or you skipped Lesson 2), follow the steps in that lesson. Use the *Resize Point Attributes* command, under the Points menu, and scale up the oak tree symbol in the Legend by a factor of 1.5.

From the Annotate menu, select the *Survey Text > Survey Text Defaults* command. Change the Offset Dimension Text - Text Alignment to Horizontal (it may have been set to Parallel in Lesson 2). Click OK. From the Annotate menu, select the *Survey Text > Offset Dimensions* command and pick the lower right corner of the building, and then the lower-most property line (in the current twist screen position). This labels the offset dimension horizontal to the current twist screen.

From the Annotate menu, select the *Draw North Arrow* command and find and select the north arrow symbol that is shown in the figure below. Change the Symbol Size Scaler, if necessary. Click OK. Then pick an appropriate location and press Enter. Note how the arrow draws due north, respecting the twist screen.

From the Annotate menu, pick the *Draw Barscale* command and pick a location near the lower-left portion of the drawing.

Your drawing should now look similar to this:
18 Select the *Hatch* command from the Draw menu. Select the SOLID pattern from the pull down list, and then click the Add: Select objects button. Pick the house and the shed, and press Enter, then OK.

19 To offset the EOP polyline, first try using the *Standard Offset* command under Edit > Offset, and try offsetting the edge-of-pavement polyline that runs roughly parallel to the sewer line. You will see an error message because that object is a 3D Polyline, created by the *Draw Field to Finish* command.

To offset a 3D Polyline, you must use a command specifically designed to offset 3D Polylines. From the Edit menu,
select the 3D Polyline Utilities > Offset 3D Polyline command. Enter the offset method as Interval, press OK.

![Offset 3D Polyline dialog box]

**Vertical/Horizontal offset amount**: 30
**Percent/Ratio/Vertical offset amount <0>:** press Enter
Select a polyline to offset: pick the EOP polyline
Select side to offset: pick out and away from parcel for the other side of the road

20 Before you add a title to the drawing, create a text style for the title. From the Draw menu, select the Text > Set Style command.

![Text Style dialog box]

Click New and name the style TITLE. Choose the font named *romant.shx* and then change the oblique angle to 10° as shown. Click Apply, and then click Close. Now, to create the title, type Dtext at the command line. Make sure that TITLE is the current text style.

Specify start point of text or [Justify/Style]: C
Specify center point of text: pick a point near the top-right of the screen
Specify height <8.00>: 20
Specify rotation angle of text <E>: pick a point to right of first point with <Ortho on>, dynamically stretch right
Text: Farmer Survey
Text: August 13, 2006
Text: press Enter twice

From the Edit menu, select the Text > Text Enlarge/Reduce command. Enter a Scaling Multiplier of .8 and pick the date you just entered.
21 Verify your drawing scale through the Settings > Drawing Setup command. Your drawing should have a scale of 100 with a Text Plot Size of 0.08. Change the Text Plot Size to 0.06 to shrink the building labels we are about to place. From the Draw menu, select the Leader > Leader with Text command and label the house "2-Story", "Farm House" (2 lines of labeling).

**Options/Size/Pick Arrow Location:** pick near or on the left side of the house

**To point:** pick off to the left

**Next point (Enter to end):** press Enter

**Text:** 2-Story

**Text:** Farm House

**Text:** press Enter

Pick anywhere on the leader. You should see two grip squares (usually blue, referred to as a cool grip), one on the left side and one of the right side. Pick on the right grip nearest the house (it should turn red, referred to as a hot grip). Move your cursor. Note how the arrow moves. Pick again for the new location and note how the arrowhead and leader are now located and angled to your specifications.

22 Select the Triangulate & Contour command from the Surface menu. On the Triangulate tab, turn off Write Triangulation File. The Contour tab of dialog box should be filled out as shown below:

Click on the Selection tab and fill out to match the following:
Click on the Labels tab and match the following dialog:

Click OK.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: press Enter

Select the Exclusion perimeter polylines or ENTER for none.
Select objects: pick the house and the shed
Since these objects have now been filled, the selection may be a little tricky. We could (actually should) have placed
the solids on their own layer and froze the layer before beginning the contour command. But we can use the fact that Carlson is filtering the objects to get around the problem. When prompted to select the objects, issue the C (for crossing) option and then pick a box that crosses the edge of the filled polylines. Carlson will accept the polyline but reject the fill.

Select the points and breaklines to Triangulate. select a right-to-left window of the property
A right-to-left selection behaves as a crossing, which means that any object that is touched by the window or included inside the window is selected. A left-to-right selection is a window selection, which means that only objects that are fully enclosed by the window are selected.

Select objects: pick Window location
Other corner: pick other location
Select objects: press Enter to end

Pick the coordinate file that contains the points, plat3.crd, and click Open.

Reading points...
Range of Point Numbers to use [<All>/Group]: press Enter
Wildcard match of point description <*>: press Enter

If the triangulation lines and faces were drawn, freeze them now. The final drawing will look similar to this:

This completes the Lesson 3 tutorial: Field to Finish for Faster Drafting.

**Lesson 4: Intersections and Subdivisions**

1 Click the icon to launch Carlson. Once in the program, exit the Startup Wizard if it appears.

2 Once in Carlson, click Open under the File pull down menu. Look for the file Plat4.dwg (this file should be located in the "C:\Carlson Projects" folder) and click on it. When it lights up blue, as shown below, it will appear in the Preview Window at right. It should look like the open-sided property shown here. You search for the file as you typically would in Windows, clicking the yellow "Up one level" button to go to the parent folder of the current folder, or by clicking the adjacent down arrow to find the desired path in the full tree of folder locations.
Now click Open to select and open the file Plat4.dwg.

3 Enter & Assign a Starting point for the Street Centerline. Select Draw-Locate Points, found under the Points pull down, and obtain the dialog shown below:

Click off the prompting and labeling for Descriptions, Elevations and Locate on Real Z Axis (make them blank as shown). Up top, change the symbol to SPT10 by picking Select at the very top of the dialog, and choosing symbol SPT10 from the dialog of symbol choices (not shown here). Also, verify that Automatic Point Numbering is clicked on, that the Starting Point Number is 1, that the layer is PNTS. Match these entries (which are mostly the default conditions) and click Enter and Assign at the lower left.
Prompting will appear at the bottom of the screen. We will enter the starting point as follows:

**Enter North(y):** 4809.17  
**East (x):** 4391.28

The program will recognize that you have not yet started a coordinate file, so click the New tab and enter the File Name as Plat4.crd (which should be the default). If you enter Plat4, you do not need to enter the extension .crd. The program will add extensions automatically. You will see this:

![Coordinate File to Process](image)

Click Open. You will be prompted again:

**Enter North(y):** press Enter (for no more points; we are done)

4 Traverse from PI to PI (to the two endpoints of our centerline). Select Traverse under the COGO menu, or alternately just enter T at the command line. (T is a hot key. Other hot keys are I for Inverse and SS for Sideshot). Reply to the prompts as follows:

**Traverse, Line OFF, RAW FILE OFF**  
**Exit/Help/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <7>:** 1  
**Enter Bearing Angle (dd.mmss) <90.0000>:** 58.1848  
**Points/<Distance>:** 736.73  
**N: 5196.15 E: 5018.19 Z: 0.00**  
**Exit/Help/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>:** E (to exit)

You could keep on traversing, but we will stop here to review. You have created point 2, traversing NE from point 1. To review, code 1 is for NE, 2 for SE, 3 for SW, 4 for NW, 5 for Azimuth, 6 for Angle Left, 7 for Angle Right, 8 for Deflection Left and 9 for Deflection Right. This is the standard way that traverses and sideshots are entered in Carlson with a code entry (followed by Enter), then the angle or bearing entry (followed by Enter). Lesson 1: Entering a Deed, presented another method, where the angle and bearing are together in the form of 158.1848. That is a rare form, designed to save keystrokes, and used primarily only in *Enter Deed Description*. Now you have been exposed to both!

5 **Line On/Off.** Click Line On/Off under the COGO menu to turn on simultaneous linework with traversing. This command toggles on and off each time you click it, with the On status indicated by a check mark. Now repeat the Traverse command. Try T for Traverse this time, entered at the command line.

**Traverse, Line ON, RAW FILE OFF**  
**Exit/Help/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>:** 2  
**Enter Bearing Angle (dd.mmss) <58.1848>:** 75.0627  
**Points/<Distance>:** 553.69
6 Draw a Polyline from Point 1 to Point 2, and connect the segments with Join Nearest. We could have turned linework with traverse on before we got started, but now we will do it after-the-fact. So choose 2D Polyline under Draw. Some users like to simply type in 2DP at the command line that starts the Polyline command. If the Polyline 2D Options dialog box appears, set the values shown below and click the OK button.

![Polyline 2D Options dialog box]

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 2
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter (to end)

Now we have two line objects. The first, from point 2 to point 3 is a pure Line. The second, from point 1 to point 2, is a true Polyline (even though it is only one segment long). It is officially a LWPOLYLINE, a lightweight polyline. This can be verified by picking it using the List command under Inquiry. Polylines are linked combinations of one or more line segments that behave as one unit. We encourage use of polylines versus lines because they offset as a unit, will take on a thickness or width, are easier to select and have superior editing capabilities. A line can be turned into a polyline by picking Polyedit under Edit, picking the line, and answering Y to the question "Do you want to turn it into one? <Y>". To join the polyline and line objects into a single polyline, choose the very useful command Join Nearest, found under Edit.
The defaults are good. Just click OK.

**Select lines, arcs and unclosed polylines to join.**

**Select objects:** pick the polyline from 1 to 2 and the line from 2 to 3, and then press Enter for no more

Now, see the grips on the new polyline by picking it with the cursor. See how the whole thing highlights? That is proof that it is joined up as a polyline.

7 Design a Curve with a 500' Radius. Under Draw, pick **Arc** and slide over to **2 Tangents, Radius**.

**Radius of Arc <0.00 >: 500**

[nea] **Pick Point on 1st Tangent Line:** pick on the 1st polyline segment closer to point 2

[nea] **Pick Point on 2nd Tangent Line:** pick on the 2nd polyline segment close to point 2

The arc draws in, and the centerline remains a polyline, now with 3 segments.

8 I for Inverse. Entering I for Inverse, at the command line, is a handy way to get on a point to begin another traverse. Practice inversing. Enter I. Inverse from point 1, then to point 2, then to point 3 then back to 1. But you can also inverse (go to) a snapped position on a line or polyline, such as the midpoint of an arc. Let's do that, because we want to traverse south from the midpoint of the arc. Enter I, for Inverse.

**Calculate Bearing & Distance from starting point?**

**Traverse/SideShot/Options/Arc/Pick point or point number:** MID (for midpoint snap of) select the arc

**Traverse/SideShot/Options/Arc/Pick point or point number:** T (for traverse)

**Traverse, Line ON, RAW FILE OFF**

**Exit/Help/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>:** press Enter

**Enter Bearing Angle (dd.mmss) <75.0627 >: 10.11**

**Points/<Distance>: 400**

**Exit/Help/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>:** E (to exit traverse)

Notice that you can transition from inverse, to traverse, to sideshot, etc. with these COGO options. We were in inverse, but we did T for traverse, and could have done I for inverse to return to inverse. This cuts down on keystrokes, and adds to the sense of fluidity of the software.

9 Turn a Line into a Polyline with Polyedit. The command **Offsets & Intersections** requires pure polylines, not lines, to execute. So, since we had Line On with the last traverse, we have created a line. To use this in street design, we need to convert it into a polyline. Select **Polyedit** under the Edit pull down menu.
Select polyline or [Multiple]: pick the side road line
Object selected is not a polyline
Do you want to turn it into one? <Y> press Enter
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]: press Enter

10 Offsets & Intersections. Under the Area/Layout > Layout Utilities menu, select Offsets & Intersections.

Select all PRIMARY road polylines.
Select objects: press Enter (we will consider both these subdivision streets secondary)
Select all SECONDARY road polylines.
Select objects: pick the main centerline
Select objects: pick the side road
Select objects: press Enter (for no more)

The street intersections are presented in a dynamic dialog as shown above. Try experimenting with different radii under the Secondary Roads column, then clicking Calculate. The streets will re-draw in the upper graphical area. But after experimenting, change the four values under Secondary Roads to those shown (ignore Primary Roads – those don’t apply here), and click Calculate. Then click Finish 2D. Note the drawn-out street intersection.

Now select Drawing Inspector under the Inquiry menu, right click and make sure Layer is checked. Hover over the outside polyline (it is layer ROW). Hover over the next polyline in from the outside (it is layer EOP). For example, if you had clicked off EOP under the Draw column in the above dialog, the edge-of-pavement polyline would not have drawn.

11 Standard Cul-de-Sac. Under Area/Layout > Layout Utilities, select Cul-de-Sacs. You may want to zoom into the area of the bottom center, near point 4. When finished with the procedure below, zoom back out.

Select all offset polylines to end with cul-de-sac.
Select objects: form a crossing selection from right to left across the lower side road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)
Select objects: press Enter (for no more)
Pick cul-de-sac center projection onto centerline: END (for endpoint snap)
of pick near the endpoint of the centerline of the lower side road near point 4
Make sure the pick is on the centerline polyline, or the routine will say the centerline not found.
This brings up the following dialog:

Again, you can change the Fillet Radius and the Outside Radius on the EOP or ROW, hit Calculate, and check out its effect (don't make the Outside radii too small or it will fail to Calculate if there is no workable solution). Set values as shown above. Then click on Finish 2D.

12 Teardrop Cul-de-Sac. Now select the *Cul-de-Sacs* routine again, under *Area/Layout > Layout Utilities*.

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *form a crossing selection* pick from right to left across the right main road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

**Select objects:** *press Enter* (for no more)

**Pick cul-de-sac center projection onto centerline:** *END (for endpoint snap)*

of pick the endpoint of the centerline of the lower side road near point 3

For a teardrop cul-de-sac, fill out the dialog as follows, then click on Calculate and Finish 2D.
Teardrop cul-de-sacs allow moving vans and other large vehicles more turning room, and have been popular in the Cincinnati area, for instance. Our drawing now appears as shown below, with the exception of the filled reference dots.

13 Let's make a layer called LOTS using Layer Control found under View. It's a good idea to create a layer and set it current before beginning the design process. Select Layer Control and obtain the following dialog:
Click on for New layer. When Layer1 highlights, as shown at bottom of list, type over it with LOTS, then click under the Color column and change the color to Magenta. Then click the (Set) Current button up top to make this layer current. Then click OK to exit the dialog.

The **Lot Layout** routine under Area/Layout works nicely with reasonable polylines that run roughly parallel. Our goal is to make 1-acre lots. Lots of zigs, zags, and jogs in the polylines cause the perpendicular offset logic to fail to find a solution (lots will radiate perpendicular from the front polyline in Lot Layout). Not only should the front and back lines run opposite each other, but they should end at some point before the calculation runs into difficulty with impossible math.

The outer R-O-W polyline currently runs left-to-right, goes around both cul-de-sacs and returns right-to-left in one, connected polyline. We need to break it near where the filled dot is pointing. It should be easy to lay out lots along the upper portion of the subdivision, as long as we stop to break the R-O-W polyline before it turns and runs back through the lower, more complex frontage and back property portions.

Under Edit, select **Break**, and slide over to **At Selected Point**. You will select using the filled dots, shown on the plan above, as references.

**Select Line, Arc, or Polyline at break point:** pick near the filled dot on the outer boundary polyline

Repeat the command for the ROW polyline.

**Select Line, Arc, or Polyline at break point:** pick the far right end of the Teardrop cul-de-sac R-O-W polyline

To prove you have broken the polylines in two, click on the R-O-W polyline on the south side (only the south portion should highlight), then click on the north R-O-W polyline (which we will use as our frontage polyline in the command Lot Layout). Then press the **ESC** key twice, which gets rid of the grips, as does zooming or panning.

14 Select Lot Layout under Area/Layout > Layout Utilities. A dialog appears:
Fill out as shown. In particular, change the Remainder to *Create Separate End Lot* so that we force 1.000 acre lots and don't just get equal lots of some size such as 1.0017 (because the remainder lot that would not fit was added onto all lots).

Making Closed Polylines means that our side lines will be doubled up, each lot sharing a side line. Click OK.

**Select front polyline:** pick north R-O-W

**Select back polyline:** Pick northernmost polyline the back property line

The 1.00 acres lots are laid out as far as is possible. You may get a small lot at the end of the row, which you would erase.

15 Applications of Reverse Polyline. We can get more Lots from Lot Layout, by doing the lower R-O-W at the left side of the drawing, and picking the southern back polyline. Let's try. Select *Lot Layout* under Area/Layout > Layout Utilities. Use same dialog entries. Select the front polyline as the southern edge of the road R-O-W, near the left side of the drawing. Select the back polyline as the southern property line. Oops! Nothing drew. It was unable to calculate. It turns out that the direction of the polyline is important. Run *Inquiry* > *Drawing Inspector* and check on *Polyline Direction*. You will see the southern R-O-W polyline starts way off to the right, so the program was not even considering where we were looking! We need to reverse the direction of the southern R-O-W polyline so it starts on the left side. Select *Reverse Polyline*, found under the Edit pull down, sliding over from *Polyline Utilities*. It prompts:

**Select polyline or line to reverse:** pick the southern R-O-W polyline

The polyline now reverses direction, goes left-to-right, and shows phantom direction lines (which are automatically removed when the command ends). Now repeat the Lot Layout command as outlined in the beginning of Step 15, and we get one new lot out of the exercise, as shown below. If you get a second wedge shaped lot, erase it.
16 Break at Intersection. The lower back property line is still continuous. We can work with it in small pieces rather than as one big polyline. Say we want to break it at the inside corner identified by the arrow above. To do this, select Edit pull down, Break, sliding over to At Intersection. Prompting:

Select Line, Arc, or Polyline to Break: pick the south property line
[app on] Pick Intersection to break at: move the cursor to the intersection point indicated in step 12, look for the INT snap to appear as you approach the exact corner (which is an intersect), then click there

17 Draw a Polyline from the corner indicated by the filled dot to the beginning of the R-O-W arc, also indicated by a filled dot in the previously referenced graphic. Select 2D Polyline under Draw and click on the OK button to dismiss the dialog box if it appears.

Pick point or point numbers: END (type in end for the endpoint snap)
of pick the inner back property corner
Undo/Arc/Length/<Pick point or point numbers>: END (type in end for the endpoint snap)
of Pick the beginning of the Arc (it will show endpt when you get close to the true start of arc)
Undo/+/-/Arc/Clos/Length/<Pick point or point numbers>: press Enter (to end)

18 Area by Interior Point. We have just created a new lot, but the lot is not defined by one, single, closed polyline. If we want to verify its area, however, we can still use the command Area by Interior Point. Select Area by Interior Point under Area/Layout.

Pick point inside area perimeter: pick inside our new lot
SQ. FEET: 40997 SQ. YARDS: 4555.2 SQ. MILES: 0.0
ACRES: 0.94 PERIMETER: 830.5

Pick area label centering point: press Enter here to avoid labeling
Pick point inside area perimeter (Enter to end): press Enter to end the command

The lot is less than one acre. We will set as a goal to extend its lower boundary to the right to obtain one acre. That is accomplished by using the command Hinged Area. But Hinged Area works best if we have a nice, closed polyline for the new lot. We can get one using the command Boundary Polyline.

19 Boundary Polyline. From the Draw menu, select Boundary Polyline.
Enter layer name for boundary polylines <LOTS>:
Enter snap tolerance <0.0001>: select OK
Select polylines.
Select objects: pick all the polylines that surround our new lot and then press Enter
Pick an internal point: pick a point in the Lot interior
Pick an internal point (U-Undo, Enter to end): press Enter
This creates a new closed polyline, in the current, LOTS layer (magenta).

20 Select Hinged Area under Area/Layout > Adjust Areas.
Define area by points or closed polyline [Points/<Linework>]? press Enter (for linework)
Select polyline segment to adjust: pick on the right-side line (make sure you pick the Lot polyline rather than the single polyline vector)
Select hinge point [endp]: pick on the upper right hinge point (see arrow)
Keep existing polyline [Yes/<No>]? N
Area: 40997.20 S.F, 0.9412 Acres
Remainder/Acres/<Enter target area (s.f.)>: A (for acres)
Remainder/SF/<Enter target area (acres)>: 1.0

The new lot draws, as shown below:

21 Next, use the Erase command to remove the segment that is pointed to above with the text Click on This Side.

22 Make two more Lots with polyline command. Instead of using Draw, 2D Polyline, we will use the straight AutoCAD polyline command. At the command line, enter PL.
Specify start point: END (type in the endpoint snap)
of pick the endpoint (which is the lower right corner of the new lot)
Current line-width is 0.00
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: *PER* (type in the perpendicular snap)
to pick on the R-O-W polyline to the right

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: *press Enter* (to end)

Now for the second lot. Referring to the drawing below, repeat the PL command, and answer as follows:

Specify start point: *NEA* (enter the nearest snap)
of pick on the property line anywhere near the circled point 1 (no need to be exact)

Current line-width is 0.00

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: *PER* (type in the perpendicular snap)
to *Pick on the R-O-W polyline near circled point 2*

Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: *press ENTER* (to end)

The drawing appears below:

23 **Issue the** *Break at Intersect* command (step 16), and break the back property polyline and the cul-de-sac R-O-W polyline at the intersections with our newly drawn polyline from step 22. Repeat this command, and break the back property polyline at the filled dot to the right of the "Sliding Side Area" label below.

24 **Repeat** *Lot Layout* with the same entries as before. The front and back polylines to select are shown below, along with the results. This gives us two more usable lots.

Next, use the 2D Polyline command to generate a segment (above the "Sliding Side Area" label below) that runs from the ENDpoint of the corner to a point PERpendicular to the R-O-W line. Next, use Boundary Polyline under the Draw menu to create a closed boundary inside it. To do this, select each boundary line in the segment, press Enter twice, pick an interior point, press Enter again.

Erasing the original segment you placed is a little tricky since the newly formed polyline is on top. When two pieces of geometry lie on top of each other, Carlson will take the one created last. Issue the *Erase* command, then hold down the control key while picking the segment above the "Sliding Side Area" label. When the single segment highlights, press enter to erase it, leaving the boundary polyline. Also note you can hold the shift key, place the cursor over object on screen, and press the space bar to cycle through entities in order to erase objects on top of each other.
25 Sliding Side Area. Because we have a small closed polyline, we can investigate another area command, the Sliding Side Area. As shown in the graphic above, we want to slide the north side of the last, smaller lot parallel to its current bearing such that the lot will contain 1.00 acres. Select *Sliding Side Area* under the Area/Layout > Adjust Areas pull down.

**Define area by points or closed polyline [Points/<Linework>]?** press ENTER for Linework

**Select polyline segment to adjust:** *pick the north side of the lot above* (shown here containing the words Sliding Side Area)

**Keep existing polyline [Yes/<No>]?** press ENTER

**Define new line by selected line, another line, angle or points [<Selected>/Line/Angle/Points]?** press ENTER for Selected

**Area:** 20375.31 S.F, 0.4678 Acres

**Remainder/Acres/<Enter target area (s.f.)>:** A (a for acres)

**Remainder/SF/<Enter target area (acres)>:** 1.0

26 Complete the remaining Lots. Using the *2D Polyline* command, under Draw, use endpoint snaps and perpendicular snaps (end and per) to draw the final 3 polylines, shown below marked 1, 2 and 3 for reference.
It may not be the most aesthetic subdivision, but we applied a lot of tools making it. But we're not done. There's some real automation ahead.

**Create Points from Entities.** We have designed a subdivision, in effect, without point numbers. This is the beauty of CAD. But we need to make point numbers in order to stakeout the subdivision. To do this, select *Create Points from Entities*, under COGO. The following dialog appears:

Set the starting point number to 5, verify the dialog as shown, and click OK. A second dialog, covering what entities to capture, appears next. Stick with the default settings and click OK.
28 Number the lots, clockwise from the upper left, using the command *Sequential Numbers*. Under Draw, select *Sequential Numbers*. This dialog appears:

![Sequential Numbers dialog](image)

Click on the *Select* button to select a desired symbol to circumscribe our sequential numbers.

![Select Symbol for Numbers](image)

Choose the circled text and click OK.
Set the *Text* value to **10** and the *Text Size Scaler* to **0.16** as shown. Then click OK.

**Pick point for label position:** *pick near the center of the first upper left lot*

**Pick point for label alignment:** *press F8 for <$Ortho on$>, pick to the right*

Now pick near the center of all of the lots, going clockwise.

When done, and back to the command line, press F8 again to set Ortho off.

The resulting drawing, with point numbers, is shown below:

29 Lot File by Interior Text. Official lot files can be created whenever a lot number or name exists within a lot as the sole text (other text may be present but could be frozen). So we will play it safe and first freeze the point number layer. Before we do, take note of the point number assigned to the NW corner of Lot 10. In our case, it is point 73 (it may be different in your case, depending on how you selected the objects in the command Convert Entities to Points).

Under View, select *Freeze Layer* and pick on one of the point numbers. Now go to the Area/Layout pull down, select *Create Lots* and slide over to select *Lot File by Interior Text*. Supply the *Lot File to Process* value as shown below.
and click the Open button.

A dialog box will appear. Be sure that is says Block Name 1. Click OK.

**Select lot lines, polylines and text.**

**Select objects:** pick the lots and the lot numbers

The Lot File will be created. Before we look at the Lot File, let's finish up and perform area annotation on the upper Lots with the *Area by Interior Point* command.

**NOTE:** If we had not made points at all lot corners using *Convert Entities to Points*, the *Lot File by Interior Text* would create points at the Lot corners. This is the reason for the *Starting Point Number* prompt. If points are found, no new ones are created. Lot files must have points at all the corners.

30 *Area by Interior Point.* Select *Area Defaults* under *Area/Layout*, and remove the *Sq. Feet* entry leaving only the *Acres* item and verify it is set to plot to 3 decimal places and click OK.
Now choose *Area by Interior Point* under the Area/Layout pull down menu and pick inside Lots 10 through 16, as shown below:

![Diagram of a property with lots numbered 10 to 16]

31 Select *Lot File Manager* under Area/Layout, and the Lot Manager dialog appears:
Pick on Lot 10 and click Report. This will lead to the Lot Report dialog box.

Be sure that your setting are as shown above, and then click Lot Report.
This dialog is typical of the many Carlson Standard Report Viewer dialogs. You can click on one or more lines, highlight them and hit the delete key on the keyboard, and these lines will delete. You can edit lines directly in the dialog. You can also save the report to disk with the Save icon shown above. To exit, click the Exit icon. The Lot Manager dialog box returns.

32 The Edit Current option within the Lot Manager dialog box can be used to describe a lot by different point numbers, or to assign a lot to a different block. This is explained here and shown below for reference purposes only.

Under Selection, select a lot to edit. Click Edit Current. You will get this dialog. Note the graphic display in the lower half, which map the Points listed above. If you've opened this dialog box, click Cancel and the Exit on the Lot Manager dialog box.

33 Re-Drawing Lots after Editing Points. Let's assume you actually changed the point numbers that define Lot 10.
That would cause the lot to draw differently. Also, you could simply alter the coordinate values of a point in the current lot file. That would also cause the lot to draw differently. Let's take the latter approach. Remember point 73? In our case, it is the NW corner of lot 10 (your case may be different as stated above). So select Edit Points under the Points pull down menu. A spreadsheet appears. Scroll down to point 73 (or whatever point is your NW corner of Lot 10).

Click on the Northing and edit it to 5050. This is for illustration purposes. In reality, you might be fine-tuning your subdivision design points. As long as the same points define the lots, you are, in effect, making a ready-made new drawing. Now select at the top of the dialog File, then Save and Exit.

**34 Draw the Lot File.** Before we draw the lot file, save your drawing by selecting Save under the File pull down menu. Then choose New, exit the Startup Wizard (if it appears), and go straight to Lot File Manager, found under the Area/Layout pull down menu. Lot Manager provides the tools for drawing lot files to the screen.

Click the Existing tab and select the plat4.lot file and click Open. Select your existing Ploat4.crd file that you created.
earlier. When the Lot Manager dialog appears, choose all Lots by clicking Select All. Then click Draw.

Apply settings required or as image above and click OK to the Draw Lots dialog box. This leads to the Auto-Annotate dialog, shown below. Use the settings shown here. Click OK.
Next comes the Area Defaults dialog, as seen in Step 30. Fill out exactly as shown in Step 30.

Click OK and then Exit. This leads to the plot shown below, created entirely from stored Lot Files, and showing our revision of Lot 10.
This completes the Lesson 4 tutorial: Intersections and Subdivisions.

Lesson 5: SurvNET

This tutorial is divided into two lessons covering the process of reducing and adjusting raw survey data into final adjusted coordinates, using the SurvNET program. The tutorial will describe the reviewing and editing of the raw data prior to the processing of the raw data. Next, the least squares project settings will be described, and then the final report generated from the least squares processing will be reviewed. This tutorial will review both a total station only project, and a project that combines both total station and GPS vectors.

The raw data files associated with this tutorial is located in the Carlson Projects folder, under the installation folder on your computer (example: \Carlson Projects).

Lesson One - Processing an Assumed Coordinate System 2D Total Station Network

1 The easiest way to start the program is to select SurvNET from the Survey menu. This opens the SurvNET window and program. If the SurvNet Start-up dialog box appears, click Cancel.

2 Open an existing project or create a new project. We will open an existing project. Choose Open Project from the File menu. Navigate to the \Carlson Projects folder and open the SurvNetTut01.prj project.
Learning the meaning and implications of the different project settings is the most critical initial step in learning how to use SurvNET. Let's review the different project screens. Choose *Project Settings* from the Settings menu.

**Least Squares Settings**

The Network Least-Squares Settings dialog box is displayed. In this dialog, the different settings required for the Least Squares reduction are available in the different tabbed dialog boxes. When all of the settings are set as desired, press OK to save the changes to the project settings, or press Cancel to return to the raw data editor without saving any project settings. For the purpose of this tutorial, the Coordinate System settings tab should look as follows before proceeding to the next step. To use an assumed coordinate system, the 'Local' Coordinate System needs to be selected, and the 2D, 1D Adjustment Model must be chosen. When using a local coordinate system, the distance units are not important other than for display purposes in the report. Computing elevation factors and performing Geoid modeling is not applicable to assumed datums. Notice that in this example we are not performing a vertical adjustment.
Choose the 'Input Files' tab. This is the section of the Settings dialog box where you define the data files that make up the project. You can have multiple raw files in a single project. The ability for multiple raw files allows flexibility in collecting the data and processing large projects. It is typically easier in a large project to analyze and edit subsets of the total project, before combining all the data for a final adjustment. Notice that since we are working in a local coordinate system and using the 2D,1D Adjustment Model, GPS vectors cannot be incorporated into this project.

NOTE: The sample tutorial project has the input raw file in the default data folder of C: \ Carlson projects. If you have a different data directory, then set the correct data file by highlighting the default file, pick Remove and then pick Add and select SurvNetTut01.rw5 from your data folder.
Choose the Preprocessing tab to review the least squares preprocessing settings. For the purpose of this tutorial, the Preprocessing settings should look as follows before proceeding to the next step. Preprocessing consists of reducing and averaging all the multiple measurements, applying curvature and refraction correction, reducing the measurements to grid if appropriate, and computing unadjusted traverse closures if appropriate. Much of the data validation is performed during the preprocessing step.

For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

Choose the Standard Errors tab to review the standard error settings. The standard error settings should look as
follows before proceeding to the next step. Standard errors are an estimate of the different errors you would expect to obtain based on the type of equipment and field procedures you used to collect the raw data. For example, if you are using a 5 second theodolite, you could expect the angles to be measured within +/- 5 seconds (Reading error).

For more information on the content of this dialog box, please review the SurvNET chapter of this manual.

8 Choose the Adjustment tab to review the Adjustment settings. The Adjustment settings should look as follows before proceeding to the next step. The Adjustment settings affect how the actual least squares portion of the processing is performed. Additionally, from the screen the user can set whether ALTA reporting is performed.
Choose the Output Options tab to review the output settings. For the purpose of this tutorial, the Output Options settings should look as follows before proceeding to the next step. These settings apply only to the output of data to the report files. These settings do not affect computational precision. Press OK to return to the main SurvNET screen.

General Rules For Collecting Data for Use in Least Squares Adjustments

Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles and distances, combined with a minimal amount of control points and azimuths, are needed. This data can be collected in any order. But there needs to be at least some redundancy in the measurements.

Redundant measurements are measurements that are in excess of the minimum number needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS, and other control points, within a network or traverse. Measuring angles and distances to points in the network that have already been located create redundancy. Running additional cut-off traverses, or additional traverses to existing control points, creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNET requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally, there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file, or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible to have one control point on one side of the project, and a reference azimuth on the other side of the project.
- At least one of the control points needs to be occupied. There may be situations where no control point is ever occupied in the network, but only backsighted. In these situations, a preliminary value for one of the occupied points needs to be computed and entered as a floating point control point.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNET requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to ensure that points are numbered correctly.
• The majority of all problems in processing raw data are related to point number problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
• It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file. A big source of problems with new users is a misunderstanding in defining their control for a project.
• Some data collectors may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points.
• When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately, as it is easier to debug small projects. Once the smaller projects are processing separately, they can be combined for a final combined adjustment.

Reviewing and Editing the Raw data

10 To review or edit the raw data, choose the **Edit Raw Files** command from the Tools menu.

11 If there are problems with the raw data, such as point numbering problems or incorrect rod heights, the raw data can be edited from this dialog. See the section on the raw data editor in the Carlson documentation to learn the details of the editor. Review the following Standard Errors and Control Points section before exiting the raw data editor.
Standard Errors and Control Points

The default standard errors for points are defined in the Standard Errors sheet of the Settings dialog box. There are times when the default values may need to be overridden. For example, the control may be from GPS and the user has differing standard errors for his various GPS points. Or maybe some of the control points were collected with RTK methods, and other GPS points collected with more accurate static GPS methods. Standard error for individual points can be inserted into the raw data file. The following is the menu option used to insert standard errors into the raw file. Notice in the above raw data file that points TR1 and TR100 are the control points for this project. Also, notice there is a standard error record, CSE, preceding the control points.

The CSE record has the character '!' in the N,E,& Z field. The character '!' designates that all following control points will be fixed. Points that are fixed will not be adjusted during the adjustment. Placing a very small standard error on a control point is almost equivalent to fixing the point. Points can also be designated to be floating points by using the '#' character. The only practical use of creating a floating point is if SurvNET cannot compute preliminary coordinates because no control point is occupied. The surveyor can compute a preliminary value for one of the
occupied points, and insert that point as a floating point. The floating point will be adjusted, and no weight will be given to the floating coordinate values.

Standard error records effect all the records that follow the standard error record. To revert the standard errors back to the default values, a CSE record can be inserted containing the '*' character. In the following example, point TR1 has been designated as a fixed point. TR100 has a north standard error of .02 and east standard error of .01. Following the TR100 point record there is a CSE record containing the '*' character. So, if there were any control points further down in the raw data file they would use the default standard errors as set in the project settings dialog box.

<table>
<thead>
<tr>
<th>No.</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Azimuth(sect.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>!</td>
<td>!</td>
<td>!</td>
<td>!</td>
</tr>
<tr>
<td>3</td>
<td>ptNo</td>
<td>Northing</td>
<td>Easting</td>
<td>Elevation</td>
</tr>
<tr>
<td>4</td>
<td>PT</td>
<td>TR1</td>
<td>5000.0000</td>
<td>5000.0000</td>
</tr>
<tr>
<td>5</td>
<td>CSE</td>
<td>0.02</td>
<td>0.01</td>
<td>!</td>
</tr>
<tr>
<td>6</td>
<td>ptNo</td>
<td>Northing</td>
<td>Easting</td>
<td>Elevation</td>
</tr>
<tr>
<td>7</td>
<td>PT</td>
<td>TR100</td>
<td>5000.0000</td>
<td>5820.9905</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

There may be times when non-control standard errors need to be overridden for certain measurements. For example, if fixed tripods were used for backsights and foresights for part of the traverse, and hand-held rods were used for another portion of the traverse, it would be appropriate to have differing 'Rod Ctr' standard errors for the different sections of the raw data.

Standard errors for angles and distances can also be inserted into the raw data file using the Add menu options **Setup Standard Error** and **Measurement Standard Error**. The standard errors set by these inserted records override the default standard errors. In the following example, a setup standard record, SSE record, has been inserted in record 12. The SSE record effects all setup data that follow until another SSE record is inserted. In the following example, the foresight rod centering error is set to .005, the total station centering error is set to .005, the total station measure-up error is set to .005 and the foresight measure-up error is set to .005.
The following is another example where it would be appropriate to insert a measurement standard error record, MSE, into the raw data. If two different total stations with different accuracy specifications were used to collect the data, it would be appropriate to have different standard errors for the different sections of the raw file, depending on which total station was used to collect the data. In the following example, an MSE record has been inserted for record 27. The horizontal pointing and reading error has been changed to 5 seconds, and the vertical pointing and reading error has been changed to 10 seconds. The inserted MSE record will effect all following raw data until another MSE is inserted.

Least Squares Processing

12 After exiting the raw data editor, we are ready to perform the least squares adjustment. From the Process menu, choose the Network Adjustment option.
The least squares adjustment is performed, and the results from the adjustment are displayed. If the solution converged correctly, the report should look similar to the following window. If there were errors or the solution did not converge, an error message dialog will be generated.

If there are errors, you will need to return to the raw data editor to review and edit the raw data. Since the tutorial example should have converged, we will next review the reports generated by the least squares adjustment. There are four windows created by the least squares program during processing. These files include the .err file, which contains any errors or warnings that were generated during processing. The .rpt file is the primary least squares report file summarizing the data and the results from the adjustment. An .out file is created containing a listing of the final coordinates. There is also a Graphics window that is displayed. The graphic window is temporary and useful only for seeing the results of the survey. To bring up the Graphics window, choose under the Window menu the Graphics command, or click the View Graphics icon on the toolbar.

Relative Error Ellipses

Relative error ellipses are a statistical measure of the expected error between two points. Regular error ellipses are
measure of the absolute error of a single point. Some survey accuracy standards such as the ALTA standards state the maximum allowable error between any two points in a survey. Relative error ellipses can give you this information. There is a more detailed ALTA reporting feature in SurvNET. See the manual for additional information on creating an ALTA report.

13 Press the Relative Error Ellipse toolbar icon button, or choose, off of the Tools menu, Relative Error Ellipse. Enter TR3 and TR7 in the From Pt. and To Pt. fields. Press OK to calculate. The dialog box should look as follows.

At the 95% confidence level there should only be around .02 feet of error between points TR3 and TR7. If you need to compute relative error ellipses for sideshots make sure the "Enable sideshots for error ellipse" toggle is set in the Adjustment tab of the Settings/Project dialog box.

**Review of the Least Squares Report**

14 In this section, the different sections of the least squares report are explained. If the Least Squares Report is not already showing, choose the Window menu and select the Least Square Report item. The report viewer has tabs to quickly access different sections of the report.

**Preprocessing and Header Information**

The following excerpt from the report shows the header information and the preprocessing results. The header information consists of the date and time, the input and output file names, the coordinate system, the curvature/refraction setting, maximum iterations, and distance units.

During the preprocessing process, multiple angles are reduced to a single angle and multiple slope distances, vertical angles, HIs, and rod heights are reduced to a single horizontal distance and vertical difference. During this process the horizontal angle, horizontal distance, and vertical difference spreads are computed. If the spreads exceed the tolerance settings from the Settings dialog box, then a warning message is displayed showing the high and low measurement and the difference between the high and low measurement.
The following excerpt from the report shows the unadjusted measurements. Measurements consist of some combination of control X, and Y, horizontal distances, horizontal angles, and azimuth measurements. These measurements consist of a single averaged measurement. For example, if multiple distances were collected between two points during data collection, only the single averaged measurement is used in the least squares adjustment.

Also, standard errors for the measurements are displayed in this section of the report. The standard errors are computed from the standard error setting in the Settings dialog box using error propagation formulas. The standard error of an angle that was measured several times would typically be lower than an angle that was measured only once.

If the data had been adjusted into NAD 83 coordinates both the ground distances and the grid distances would be displayed. The grid, elevation, and combined factor would also be displayed in this section of the report.

Unadjusted Measurements

The next section of the report shows the final adjusted coordinates. Additionally, the computed standard errors of the coordinates are displayed. If this project was reduced to NAD 83, the final latitude and longitudes are also displayed.

Adjusted Coordinates

The next section of the report shows the final adjusted coordinates. Additionally, the computed standard errors of the coordinates are displayed. If this project was reduced to NAD 83, the final latitude and longitudes are also displayed.
Adjusted Coordinates

--------------------

Adjusted Local Coordinates

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N</th>
<th>E</th>
<th>NERR</th>
<th>ERR</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR2</td>
<td>5063.3244</td>
<td>4121.3148</td>
<td>0.0062</td>
<td>0.0032</td>
</tr>
<tr>
<td>TR1E</td>
<td>4781.3723</td>
<td>4908.03957</td>
<td>0.0059</td>
<td>0.0041</td>
</tr>
<tr>
<td>TR3</td>
<td>4168.0625</td>
<td>4120.3829</td>
<td>0.0072</td>
<td>0.0034</td>
</tr>
</tbody>
</table>

Adjusted Coordinates Error Ellipses, 95% CI

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Semi Major</th>
<th>Semi Minor</th>
<th>Max. Error Az.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Axis</td>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>TR2</td>
<td>0.0160</td>
<td>0.0172</td>
<td>N 73-48'37&quot;E</td>
</tr>
<tr>
<td>TR1E</td>
<td>0.0147</td>
<td>0.0167</td>
<td>N 00-15'55&quot;E</td>
</tr>
<tr>
<td>TR3</td>
<td>0.0211</td>
<td>0.0150</td>
<td>S 55-13'56&quot;E</td>
</tr>
<tr>
<td>TR2C</td>
<td>0.0230</td>
<td>0.0210</td>
<td>S 70-53'51&quot;E</td>
</tr>
<tr>
<td>TR2E</td>
<td>0.0222</td>
<td>0.0178</td>
<td>S 06-45'02&quot;E</td>
</tr>
</tbody>
</table>

Adjusted Measurements

The following section from the report shows the final adjusted measurements. This section is one of the most important sections to review when analyzing the results of the adjustment. In addition to the adjusted measurement, the residual is displayed. The residual is the amount of adjustment applied to the measurement. The residual is computed by subtracting the unadjusted measurement from the adjusted measurement.

The standard deviation of the measurement is also displayed. Ideally, the computed standard deviation and residual and the standard error displayed in the unadjusted measurement would all be of similar magnitude. The standard residual is a measure of the similarity of the residual to the a-priori standard error. The standard residual is the measurement residual divided by the standard error displayed in the unadjusted measurement section. A standard residual greater than 2 is marked with an "*". A high standard residual may be an indication of a blunder. If there are consistently a lot of high standard residuals it may indicate that the original standard errors set in the Settings dialog box were not realistic.

Adjusted Observations

--------------------

Adjusted Distances

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Distance</th>
<th>Residual</th>
<th>Strikes</th>
<th>Stride</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR1</td>
<td>TR100</td>
<td>826.99</td>
<td>-0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>TR1</td>
<td>TR2</td>
<td>887.49</td>
<td>0.01</td>
<td>0.11</td>
<td>0.01</td>
</tr>
<tr>
<td>TR1</td>
<td>TR3</td>
<td>238.02</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR2</td>
<td>TR3</td>
<td>854.36</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR2</td>
<td>TR5</td>
<td>577.22</td>
<td>0.02</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR2</td>
<td>TR6</td>
<td>560.29</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR3</td>
<td>TR4</td>
<td>401.82</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR3</td>
<td>TR5</td>
<td>577.22</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR3</td>
<td>TR6</td>
<td>823.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.01</td>
</tr>
<tr>
<td>TR4</td>
<td>TR7</td>
<td>481.48</td>
<td>0.02</td>
<td>2.88</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.01

Adjusted Angles

<table>
<thead>
<tr>
<th>FS Sta.</th>
<th>OX Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>Residual</th>
<th>Strikes</th>
<th>Stride (Sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR100</td>
<td>TR101</td>
<td>TR1</td>
<td>180-13'16&quot;</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>TR102</td>
<td>TR103</td>
<td>TR1</td>
<td>080-17'16&quot;</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

Root Mean Square (RMS) 0.01

Statistics
The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network.

The standard error of unit weight relates to the overall adjustment and not to an individual measurement. A value of one indicates that the results of the adjustment are consistent with the prior standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a-priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the measurements themselves did not change.

In our example the chi-square test failed at the 95% significant level. Our example failed the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates that our data is actually better than expected compared to our a-priori standard errors. If we were to decrease the pointing and reading standard error in the Settings menu by 5-10 seconds we would probably pass the chi-square. Also notice that if you change the standard errors by only 5-10 seconds and reprocess the data the final coordinates will not change significantly.

### Statistics

Solution converged in 2 iterations  
Degrees of freedom: 84  
Reference variance: 0.63  
Standard error unit weight: 1/0.79  
Failed the Chi-Square test at the 95.00 significance level  
60.540 <= 52.627 <= 111.242

### Sideshots

If the "Enable sideshots for relative error ellipses" is not set in the Adjustment screen of the project settings screen, sideshots are computed separately after the adjustment is completed.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E Stdev.</th>
<th>N</th>
<th>E Stdev.</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>TU1</td>
<td>100</td>
<td>47°22'23.72&quot;E</td>
<td>20.66</td>
<td>4696.7441</td>
<td>509.9686</td>
<td>0.0026</td>
<td>0.0089</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>101</td>
<td>49°39'44.76&quot;E</td>
<td>23.25</td>
<td>4609.7896</td>
<td>508.4128</td>
<td>0.0028</td>
<td>0.0094</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>102</td>
<td>51°04'55.55&quot;E</td>
<td>25.04</td>
<td>5125.6541</td>
<td>508.6773</td>
<td>0.0025</td>
<td>0.0088</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>103</td>
<td>52°10'34.56&quot;E</td>
<td>26.63</td>
<td>5083.7499</td>
<td>509.4693</td>
<td>0.0026</td>
<td>0.0094</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>104</td>
<td>57°44'41.44&quot;E</td>
<td>38.78</td>
<td>5083.4480</td>
<td>5109.4600</td>
<td>0.0047</td>
<td>0.0074</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>105</td>
<td>60°09'42.34&quot;N</td>
<td>210.17</td>
<td>5060.0979</td>
<td>4961.0099</td>
<td>0.0049</td>
<td>0.0094</td>
<td></td>
</tr>
<tr>
<td>TR1</td>
<td>106</td>
<td>58°49'43.47&quot;N</td>
<td>209.16</td>
<td>5061.8096</td>
<td>4941.0099</td>
<td>0.0049</td>
<td>0.0094</td>
<td></td>
</tr>
</tbody>
</table>

If the project had valid elevation benchmarks and measured HI's and rod heights the project could have been defined to adjust elevations. When using the 2D/1D least squares model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network can also be reduced and adjusted using least squares. In the vertical adjustment, benchmarks are held fixed.

This is the final step in the adjustment. The final adjusted coordinates are now stored in the current project point database and can now be used for mapping and design.

### Lesson Two - Processing a 3D Network With Both Total Station Data and GPS
Vectors

In this lesson we will process a project that contains both GPS vectors and total station measurements.

1. Following is the opening SurvNET window. The first step is to open the project for lesson two. Choose the File > Open Project option. Navigate to the \Carlson projects directory and open the SurvNetTut02 project.

2. Let’s review the project settings. Go to Settings > Project Settings.

In order to process GPS vectors, the coordinate system must be set to 'SPC 1983' with the appropriate state plane zone. The 'Coordinate System Adjustment Model' must be set to the 3D Model. With the 3D model, horizontal units and vertical units must be the same in regards to output and total station raw data. Geoid modeling may or may not be
important depending on the extent of the project and the accuracies required. The most accurate results are typically obtained by using a 'Geoid File' set to GEOID03.

The project raw data is defined from the 'Input Files' settings screen. Notice that the units need to be specified for both the GPS vector data and the total station raw data. Typically, but not always, GPS vectors are in meters while the total station and the final output may need to be in feet. Also make sure that the correct GPS vector format is correct. Some GPS formats are binary and cannot be edited easily. Sometimes it is needed to edit the GPS vectors usually in terms of point numbers.

NOTE: The sample tutorial project has the input raw file in the default folder of C:\Carlson Projects. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select GPSAndTS.cgr (C&G format raw file) from your data folder. Do the same for the GPS Vector files of GPSAndTS1.gps and GPSAndTS2.gps.
Though this tutorial does not cover the topic, it is from this screen that you would define the traverse file needed to compute either GPS loop closures or totals station traverse closure. See the manual for further details.

Notice the standard error settings related to GPS. The GPS instrument centering error can be defined. The vector standard error is a factor that can be used to increase the standard errors as defined in the GPS vector files.
None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Adjustment' dialog box.

None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Output' dialog box. Press the OK to return to the main SurvNET dialog box.

2 Following is the main SurvNET window. To process the data chose the Process/Network Adjustment option.
The project should process and converge and the following windows should be displayed.

Let's review sections of the report that are unique to the processing of GPS vectors and the 3D model.

Unadjusted Observations

Control coordinates: 1 observed Points, 0 Fixed Points, 0 Approx Points

Sta.  Latitude    Longitude  Z (feet)  Stem N  Stem E  Stem Z
---  --------   --------     -----     -----     ------     ------     ------
    40-18-50.5634'  75-12-45.8507'  654.25     0.0000    0.0000    0.0000

Grid XYZ

Sta.  N (feet)  E (feet)  X (feet)  Stem N  Stem E  Stem X
---   ------    ------    ------    ------    ------    ------
    359709.1900  139058.1700   818.22    0.0000    0.0000    0.0000

Geocentric XYZ

Sta.  N (feet)  E (feet)  X (feet)  Stem N  Stem E  Stem X
---   ------    ------    ------    ------    ------    ------
    1560984.3895 -4796605.1294  4104125.27    0.0000    0.0000    0.0000

Notice that now that we are working with a specific datum, as opposed to an assumed coordinate system that latitude/longitude, state plane coordinates and geocentric coordinates are all displayed.
In the above unadjusted observations section of the report, notice that distances have been converted to mark to mark distances. Note that vertical angles are now treated as measurements in the 3D model. And lastly, notice that the GPS vectors are also displayed. The GPS vectors are displayed as delta X,Y,& Z in the geocentric coordinate system.

In the above adjusted coordinate section of the report, notice that the grid, elevation, and combined factor are displayed with the adjusted geographic coordinates.
In the above adjusted measurements section, the adjusted measurements are shown along with their residuals, standard residuals, and standard deviation.

This completes the Lesson 5 tutorial: SurvNET.

**Lesson 6: Contouring, DTM and Design**

This is the easiest of the tutorials, and could be completed in as little as three minutes. If that is all the time you have, and you have purchased the Civil Design program, do this one first!

1 Click the desktop icon for Carlson and start-up Carlson Software.

2 Once in Carlson, start a new drawing (exit out of the Start Wizard if it appears) and go straight to the Points pulldown menu. Choose Set CooRDinate File. You will then be asked to choose the coordinate file that you want to use. Select Topo.crd as shown here, and click Open.
Now go to *Draw-Locate Points* under the Points pulldown menu. You obtain this dialog:

Choose Symbol 10 by clicking Select at the top of the dialog, then picking Symbol SPT10 from the options that appear. All other settings are default. Verify that you match what appears here. Then click the option Draw All.

The points immediately plot on the screen, and the program zooms to the extents of the points. If you don't see the points, select *Extents* under View. The point plot is shown below:

3 Triangulate & Contour. Be sure you are in the Civil Design program (Pick *Civil Menu* under Settings > Carlson Menus). Under the Surface pulldown menu, pick *Triangulate & Contour*. The following dialog boxes will appear which you should fill out as shown. We'll start with the Contour tab.
In the Contour tab, as shown above, set the contour interval to 5.0, turn on Draw Index Contours and set its interval to 25.0 (index intervals are most often 5 times the standard contour interval). The Contour tab should appear as shown above. Click on the Triangulate tab.

In the Triangulate tab (as shown above), set the Maximum triangle mesh line length values to 300 in all cases. If the goal of the field crew was never to shoot points further apart then 100 feet, then certainly triangulation over 300 feet can be ignored. Click on the Labels tab.
In the Labels tab, we want to label index contours only (so it's not too busy) and do 2 internal labels per contour. This works very well for a valley. It puts a contour label on each side of the valley. Sometimes you may prefer to label a specific length of contour.

Fill the dialogs in as shown, and press OK. Also look at the selection tab at the top and set settings as required or needed.

Select the points and breaklines to Triangulate.
Select objects: ALL (All means select everything visible on the screen)
615 found
Select objects: press ENTER (for no more)

The contours are drawn. Now, choose the command Freeze Layer under the View menu and pick on one of the points (its number or its elevation), and press Enter. The points freeze. Here is the plot so far:
4 Edit Contours. The arrow above points to an area that needs editing. This area is enlarged below. You may want to zoom into this area for the next edit operation, and zoom back out when you are finished.

Choose the command *Edit Contours*. This is found by going to the Surface pulldown menu and choosing *Modify Contours*.

- **Select contour to edit**: *click on the 1460 contour* (leftmost cursor, shown above)
- **Pick intermediate point (Enter to end)**: *click for the new position of the 1460 contour*
- **Pick intermediate point ('U' to Undo, Enter to end)**: *click a 3rd time*
- **Pick intermediate point ('U' to Undo, Enter to end)**: *click a 4th time* (more if desired you are re-drawing the contour, in effect)
- **Pick intermediate point ('U' to Undo, Enter to end)**: *press Enter* before you want to reconnect to the original 1460 as above
- **Pick reconnection point on contour**: *pick on the 1460 contour to reconnect*
- **Select contour to edit**: *continue and edit other contours, as desired or press Enter to end*

The *Edit Contour* command will keep every edited contour (e.g. our 1460 contour) as a single polyline. The edited segment is auto-joined to the before and after segments. Results below:
5 Draw a Polyline across the Valley to represent the Centerline of a dam. Choose the Draw pulldown menu and select 2D Polyline (near the top of the menu). Click the OK button on the Polyline 2D Options dialog box if it appears. This is an enhanced version of the standard polyline command which draws the same polyline entity that you get when you type PL at the command prompt. Try to split the valley with the polyline (see below).

6 Making Grid Files. A grid file can be used for volumes, comparing one grid to another. While we have the original contours visible, we should save a Topo-e grid file (topo-existing). Select Make 3D Grid File under the Surface pulldown menu. Let’s call the original ground grid Topo-e as shown in the dialog here.
Click Save. This leads to another dialog:

Use the settings shown in this above dialog box (plenty accurate for this application). Click OK.

**Pick first grid corner:** *pick to the lower left of the topo area*

**Pick opposite grid corner:** *pick to the upper right of the topo area*

**Select points, lines, polylines and faces to grid from.**

**Select objects:** *ALL (again we can use the all selection)*

**Select objects:** *press Enter (for no more)*

The file Topo.e.grd is then stored.

Tip: Whenever you make Carlson files, such as coordinate files (crd), grid files (grd), and even pond capacity files (cap), they store to disk. When you do an Undo command (U for undo), you undo the graphics, but the files are safely stored and are not undone. Carlson does not like to overdo making files. Make them if you want, but we will
not make any that are not needed. The entire contouring process, above, was completed without making a single new file, for example, though there were options, clicked off by default, to make files.

7 Design Valley Pond. Select \textit{Design Valley Pond} which can be found under Surface > Design Pond.

Pick the top of pond polyline: \textit{pick the polyline as drawn earlier}
Select the grid file Topo-e.grd. Then click Open. If we had no grid file, we could have chosen the screen-select option, and selected all objects.

Pick a point within the pond: \textit{pick upstream (northwesterly) of the polyline}

Enter the outslope ratio \textless 2.0\textgreater : 3
Enter the interior slope ratio \textless 3.0\textgreater : 4

Range of existing elevations along dam top: 1421.43 to 1576.42
Enter the top of dam elevation: 1460

Calculate stage-storage values \textless Yes/No\textgreater ? \textit{y}

Method to specify storage elevations \textless Automatic/Interval/Manual\textgreater ? press Enter

The following report includes earthwork volumes and water storage volumes.
Click the Exit icon to continue forward in the process.

**Output grid file of final pond surface [Yes/No]? Y**

Save the surface, that includes the pond, in the file Topo-d for Topo with dam.

**Write stage-storage to file [Yes/No]? Y**

Save the pond stage-storage curve information to a file (choose any name). Click Save.

**Adjust parameters and redesign pond [Yes/No]? N**

**Retain trimmed polyline segments [Yes/No]? N**

The process is complete. At the command line, enter E for erase and then when it says **Select objects**: pick on the centerline of the dam, then Enter for no more picks, and the centerline will erase.

Tips: The stage-storage curve that you save will plot in the Carlson Hydrology program. It makes a nice, handy plot for report purposes. See Lesson 11 - Hydrology and Watershed Analysis. Also, it's always good to save your drawing periodically.

8 Check it out in 3D. Select the **3D Viewer Window** option, under the View pulldown.

**Select all entities for the scene.**

**Select objects**: ALL (again, we use the all selection)

**Select objects**: press ENTER for no more

This leads to the starter view (a plan view) shown below:
The main trick is to move the X-Axis bar to the left. Avoid the Y-Axis dial for now, and then grip on the Z-Axis dial and move it back and forth relatively fast, or just click on the Z-Axis arrows and watch things move slower. It's like you are in a helicopter over the site. Here's an example:

9 Exit the 3D Viewer. Now choose 3D Polyline by Slope on Surface, found under 3D Data > 3D Polyline Utilities.

Enter the polyline layer <SLOPE_PLINE>: press OK (to accept this)
Now select the grid file. The file is Topo-d.grd.
Limiting length for polyline (Enter for none): press Enter
Pick origin point of 3D polyline: pick a point on the south side of the top of the dam, just before it contacts the ground
Direction of 3D polyline [Up/Down]? D
Direction of 3D polyline facing down slope [Left/Right]? R
Slope format [Percent/Ratio/Degree]: press Enter
Enter design slope percent: 10
Your information should be similar to this:
Horizontal distance: 693.65, Slope distance: 697.12
Vertical drop: 69.41, Avg slope: 10.01%, Max slope: 10.06%

Pick origin point of 3D polyline (Enter to end): press Enter (no more)

This created a smooth, 10% downhill grade 3D polyline, as shown, which we can use to construct a maintenance road up to the dam.

Offset 3D Polyline. This is a Carlson specialty; a high-powered Civil Design feature. In short, you can work in 3D because you can offset and manipulate 3D polylines using Carlson. So Select Offset 3D Polyline, under 3D Data > 3D Polyline Utilities.

press OK to the above dialog
Vertical/Horizontal offset amount>: 30 (for a 30' wide road)
Percent/Ratio/Vertical offset amount <0>: press Enter
Select a polyline to offset: pick our new 3D polyline
Select side to offset: pick into the hill, to the left or SW
Select a polyline to offset (Enter for none): press Enter (for no more)

This creates the other side of the road parallel, but not joined yet. For that we use Join Nearest.

11 Select Join Nearest under the Edit pulldown menu. A dialog appears which you need to fill out as follows:

![Join Nearest Options dialog]

The most important aspect is to click Directly Connect Endpoints, and tolerate the fact that they are 30’ apart by allowing for a Max separation to join of 31. That way, they will join! Click OK.

Select lines, arcs and unclosed polylines to join. pick both sides of the road one at a time, carefully avoiding picking a contour
If both the edge of roads are picked and highlighted, hit Enter to avoid additional selections.
If a contour is picked, press ESC to exit the command and start over, or press R for remove, pick it to remove it from the selection set, then A to Add, and pick again on the road.
Tip: This may be obvious, but when it is difficult to pick what you want, because several objects are nearby or overtop what you want, it pays to do View, Window and zoom in closer, followed by View, Previous after you are done.
We have a road, or at least a sloping pad, seen below:
Pad Template is one of the more diverse and powerful commands in Carlson. We will use it here to make a simple cut and fill slope from our road pad. We will go 0.5:1 in cut, but 1:1 in fill. You might think a 2:1 in fill is better, but remember, our hillside edge of road (the original edge) follows very closely to the hill itself, as designed. If it cantilevers out a few inches, and the natural slope of the ground is 1.5:1 (which it is!), 2:1 will never catch, and we will create big fill areas. So we will go with 1:1 in fill, and get very tiny, quick tie-ins in those few cases where there is any fill at all.

Pick Design Pad Template, a command under the Surface menu. A dialog appears. Use the standard entries, as shown below:

![Design Pad Template dialog](image)

Click OK. Pick two limit points of pad disturbed area. Another dialog appears. Make sure the entries match what is...
Click OK.

**Pick the pad polyline:** *pick the road pad*

**Enter the fill outslope ratio <2.0>:** 1

**Enter the cut outslope ratio <1.0>:** 0.5

**Calculate earthwork volumes [Yes/No]?** Y

A report is produced similar to Valley Pond. Review and Exit it.

**Adjust parameters and redesign pad [Yes/No]?** N

**Write final surface to grid file [Yes/No]?** Y

Store to the file Topo-f, for Topo final.

**Trim existing contours inside pad perimeter [Yes/No]?** Y

**Retain trimmed polyline segments [Yes/No]?** N

**Contour the pad [Yes/No]:** N

Select the 3D Viewer Window option, under the View pulldown to view the drawing now with a road. This completes the Lesson 6 tutorial: Contouring, DTM and Design.

**Lesson 7: Contouring, Break Lines and Stockpiles**

1. Click the desktop icon for Carlson and start-up Carlson Software.

2. Once in Carlson, exit out of the Startup Wizard (if it appears) and click *Open* under the File pulldown menu. Look for the file Mantopo.dwg drawing in the "\Carlson Projects" folder and open it.

3. Select Triangulate & Contour from the Surface pulldown menu (within the Survey module). Click the Contour tab. Let's target contours at a 1-unit interval, and contour the area of points. You will see this dialog:
Make all settings as shown (most of them are the default). We want to make sure that the Contour Interval (top right) is set to 1. Also, be sure to set the Index Interval to 5. Click OK.

**Select the points and breaklines to Triangulate.**

*Select objects:* ALL (All means select everything visible on the screen)

*Select objects:* *press Enter* (for no more)

A dialog box appears. Select Mantopo.crd as your coordinate file. Click Open and the points will be read from the crd file.

**Range of Point Numbers to use [All]/[Group]:** *press Enter* (to accept All)

**Wildcard match of point description <*:** *press Enter*

Contours are drawn, but notice the unacceptable wavy look around the perimeter, an area which is meant to be a ditch.
Type in U for Undo and press Enter until the new contours (at left) disappear and you are back at the command prompt.

4 Field-to-Finish: From within the Survey module (Settings > Carlson Menus > Survey Menu), under the Survey pulldown menu, select Draw Field-to-Finish.

You will be prompted for the CRD file to process. Choose the Existing tab, then select mantopo.crd, which resides in the main Carlson Projects folder, and click Open. The Draw Field to Finish dialog appears.

![Draw Field to Finish dialog](image)

At the lower left of the Draw Field to Finish dialog, click Edit Codes/Points. The Field to Finish dialog appears.
On the left side of the Field to Finish dialog, under the heading Code Table, there is an option called Code Table Settings. Click on it. You will see this dialog:

As you can see at the top of the Code Table Settings dialog, the default Field to Finish code definition (.FLD) file is Carlson.fld. We want to make a new code table because the coordinate file for the field survey includes special coding (17 and 18) for ditch lines and top of banks.

You can react and adjust to whatever a field crew uses by making a new field-to-finish table that can load up the codes right from whatever descriptions were used in the field. To do this, click Set at the upper-right of the Code Table Settings dialog, then choose the New tab (for new file) and you might name it Mantopo, as shown below (noting the "Carlson Projects" folder):
Click Open. You will be taken to the previous dialog.

Notice how "Carlson Projects\Mantopo.fld" is now listed at the top. Click OK. You will return to the main Field to Finish table, completely empty, as shown below:
Now, get a jump start on the table by choosing the option *Code Table by CRD* (located in the lower left of the dialog). Choose *Append* on the subsequent dialog box (shown below).

In this lesson, we only care about code 17 and 18. Select all other codes (the *GROUND* code in this case) and click the *Delete* button to remove that Code from the list. Now select Codes 17 and 18 (by holding the CTRL or SHIFT key down while picking) as shown below.
Pick the *Edit* button under Code Definitions. The Multiple Set dialog appears.

Click the *Entity* button to establish the type of entity that should be drawn for codes 17 and 18 as shown below. Make all settings as shown in this box. We will turn them both into 3D polylines (which will act as break lines or barrier lines for contouring). Accept the 3D Polyline choice by clicking OK, then hit Exit, which will take you back to the Field to Finish dialog.
The last steps are to first save the Field-to-Finish (.FLD) file Mantopo by clicking the Save button. Then click Draw (lower right) to draw the 3D polylines. You will see the following dialog which allows you to control the details of what to draw. Make sure the Lines option is the only entity to be drawn, not points, symbols, or 3D faces. Let’s take a quick look at the Additional Draw Options.

Make sure that the Point Label Settings are set so that you can see the points properly.
Click OK to both dialog boxes. The following drawing is created. All the ditch lines and top of bank lines, because they were coded 17 and 18, are drawn in one quick procedure.

Because the field crew did not use start and stop logic (e.g. appending 7 or some agreed upon code to a description could end a polyline and start another), some polylines connect that should not. In particular, the line near the NW corner is clearly crossing the ditch line. It must be removed. Choose the Edit pulldown, then Polyline Utilities > Remove Polyline > Remove Polyline Segment.

**Break polyline at removal or keep continuous [<Break>/Continuous]**? press Enter
Select polyline segment to remove: select the polyline segment to the right of point 127 indicated by the arrow below.
You will recognize this as a long segment running from point 127 to point 50.
Select polyline segment to remove: press Enter (for no more)

6 Return back up to the Surface Menu, pick *Triangulate & Contour* and use the same Contour settings as before. Then do a right-to-left crossing selection as before (avoiding the stockpile at the lower right). Select the *Mantopo.crd* file again.

**NOTE:** You may be alerted of a crossing breakline scenario located at the northeast corner of the site. Use the *Zoom To* and *Zoom In/Out* buttons to explore the data geometry at this area of the site. As an optional exercise, experiment with the *Draw Field to Finish* > *Edit Codes/Points* > *Edit Points* routine to adjust the location(s) or coding of the offending point(s).

Now we get excellent contours, with a sharply defined ditch. Under View, do *Freeze Layer* and pick on a point. The points will freeze.

Here is the improved drawing, helped out by 3D polylines that were produced by *Draw Field-to-Finish*. 
Delete Layer. Let's say that now you don't want the break lines in the drawing (since they can be easily re-created with Draw Field to Finish). You don't want to even freeze them; you want to fully delete them. There is a command for that under Edit. Pick Erase, sliding over to Erase by Layer. This dialog appears:

If you know the layer names, you can just type them in. If you know where they are but not their names, then click on Select Layers from Screen. If you'd recognize the layer name if you saw it in a list, click Select Layers by Name. Click on Select Layers by Name and pick 17 and 18, then OK twice. Notice the change in the drawing.

Explode. Inserted Drawings should be exploded so you can work with their individual components. From the View pulldown, choose the Window command and window in on the stockpile at the lower right of the drawing. If you type E to Erase, and try to erase any aspect of the stockpile, the whole stockpile will erase with all its features. That is because the Stockpile was another drawing inserted into this drawing. Sometimes other drawings that are inserted are referred to as Blocks. In any case, this stockpile “block” needs to be exploded. Explode just breaks it up into its unit objects which then start to behave normally. Select Explode under Edit and slide over to Standard Explode. Then pick the stockpile. It is now a set of normal objects.

It's also worth noting that while the block has been exploded, it still exists in the drawing as a block definition.
This means that now that it’s exploded it is taking up twice the amount of storage space in the drawing. As such, you should purge the drawing of the unused block, or turn on the explode toggle when inserting one drawing into another. As a basic rule, if it’s a symbol, don’t turn on the explode toggle; if it’s a complete drawing, turn it on.

9 Change Elevations. Let’s assume our stockpile drawing is too high and should be lowered in elevations by 540 units. To best see the effect of this command, bring back the points by selecting Thaw Layer under View. Now select the Edit pulldown, and then Change > Elevations.

Type of elevation change [Absolute/<Differential>/Scale]: D
Positive number increases, negative number decreases elevation.
Elevation difference <0.00>: -540
Ignore zero elevations [<Yes>/No]? press Enter
Change Layer for changed entities [Yes/<No>]: press Enter
Select Entities for Elevation Change.
Select objects: do a lower right pick to upper left pick (automatic crossing) selection around the stockpile
Select objects: press Enter (for no more)

Notice in the drawing below how the points, breaklines and contour polylines have changed in elevation with the exception of the contour text.

Initiate the command List Elevation under the Inquiry pulldown, pick on an index contour, and notice how the elevation has indeed changed. Repeat step 7 and delete the layer CTEXT, so as to remove the 5 index contour elevations, which are no longer accurate.

10 Volumes by Layer. One of the signature commands of Carlson, Volumes by Layer, will produce accurate volumes without making any files. The only prerequisite is that the data for the existing and final surfaces exist in the drawing on separate layers. It is also very important to have an inclusion perimeter to define the limits where the volumes should be calculated. In our example, the original ground will be the 3D polyline connecting points 1 through 15, and everything else above will be the final ground (including the 3D perimeter itself).

Make sure that you are in the Civil module (Settings > Carlson Menus > Civil Menu). Select Volumes by Layers. This command is found under the Surface > Volumes by Grid Surface.

Pick Lower Left limit of surface area: pick below and to the left of the stockpile, but as close as possible to the
stockpile without clipping it in the window
You want to totally include it, but with little wasted margin.
**Pick Upper Right limit of surface area:** *pick above and to the right* of the stockpile

A dialog appears:

We will stick with the defaults, as shown. Notice that we are using 50 grid cells within our window and since our window was not a perfect square, the cell sizes are not whole numbers. In this example it is 6.73 x 5.32. You may have slightly different sizes. Seeing this, if we wanted 5 x 5 cell size, we could click the Dimensions of a Cell option and set the size to 5 x 5. Hundreds or thousands of cells in both directions will increase calculation time. You can experiment with more cells or, if you prefer, smaller cells (which makes more cells). However, you will begin to see diminishing returns in terms of accuracy changes as your cell size continues to shrink. After a while (depending largely on the spacing of the source data), tighter, smaller cell sizes don't add any value to the precision of the calculation. Click OK.

Then pick the layers that define the existing ground (PERIMETER) and the layers that define the final ground (PERIMETER, PNTS, BARRIER, CTR, CTRINDEX).

Then click OK. Notice how the Perimeter layer is common to both. If you want to be a master of volumes, remember this as a mantra: The perimeter should be a 3D polyline in a distinct layer, common to both surfaces. A stockpile is just a special case in that sometimes the 3D perimeter is all you know about the base surface.

When asked to *Select objects*, do a right-to-left (crossing) selection of the entire stockpile area. Lastly, you will be asked for the inclusion perimeter (pick the perimeter polyline) and the exclusion perimeter (none). This leads to a flexible reporting and output dialog:
Elevation Zone Volumes, for example, would produce volumes in any desired increment from the base of the stockpile going up. If the stockpile consists of coal (80 lbs/c.f.), then Report Tons can be clicked on and a Density value entered.

Click OK, and the basic report is produced, as seen below.

Click the Exit icon to return to the command prompt.

11 Stockpile Volumes. Our Stockpile is naturally well-suited for applying the simplest volume command of all Stockpile Volumes. It requires that the 3D perimeter polyline for the stockpile be placed in a layer called Perimeter, which ours is. So let's try it.

Select Calculate Stockpile Volume found under the Surface > the Stockpile/Ponds/Pit Volumes menu.

**Ignore zero elevations [<Yes>/No]? press Enter**
Select stockpile entities and perimeter. crossing select (right-to-left picks) the entire stockpile area. The grid resolution dialog (note that it is still at 50x50) appears again. Click OK. A report is generated.

This completes the Lesson 7 tutorial: Contouring, Break Lines and Stockpiles.

**Lesson 8: A Dozen Tools for Surface Design**

Tool 1 - Draw 2D Polyline
Tool 2 - Draw 3D Polyline
Tool 3 - Offset 3D Polyline
Tool 4 - Join Nearest
Tool 5 - Bench Pond
Tool 6 - Valley Pond
Tool 7 - 3D Polyline by Slope on Surface
Tool 8 - 2D to 3D Polyline by Surface Model
Tool 9 - Input-Edit Profile
Tool 10 - Profile to 3D Polyline
Tool 11 - Design Template
Tool 12 - Design Pad Template

1. Click the desktop icon for Carlson and start-up Carlson Software.
2. Once in Carlson, exit out of the Startup Wizard (if it appears) and click Open under the File pulldown menu. Look for the file example2.dwg drawing in the "\Carlson Projects" folder and open it.
3. Since example2.dwg will also be used multiple times throughout this tutorial, you might want to make a copy so that you don't overwrite the initial drawing. Click Save As in the File menu and choose a different name, such as example2a.dwg.
4. Load the Civil Module by running Settings->Carlson Menus->Civil Menu.
I. Working with Polylines

A. Draw->2D Polyline (Tool 1)

The most basic use of a polyline is for the creation of flat-bottomed pits and flat "building pads" at any desired elevation. See the two polyline examples shown here.

The rectangle was carved out of the map by first doing the Rectang command, and making a rectangular polyline in the SW corner of the map as shown above. Then we did Erase by Closed Polyline, under the Edit pulldown, selecting the rectangular perimeter and checking Erase Outside. The two polylines are drawn by the Rectang command for the pit, and the PL command at an elevation of 0.00 for the pad as shown above (make sure to use the 'Close' option for the final line).

Then, we selected Design Pad Template, found in the Surface pulldown menu. Make sure Source of Target Surface Model is set to Screen Entities and pick OK. We began with the rectangular pit.

Pick Lower Left limit of pad disturbed area: pick the lower left of map
Pick Upper Right limit of pad disturbed area: pick the upper right of entire map
A dialog box appears. Click OK to accept defaults.
Pick the pad polyline: pick the rectangular pit
Enter the fill outslope ratio <2.00>: 1
Enter the cut outslope ratio <1.00>: 1
Enter the pad elevation: 1960 (Elevation of the pit)
Calculate earthwork volumes [<Yes>/No]? press Enter
Review the report, and then Exit from it.
Adjust parameters and redesign pad [Yes/<No>]? press Enter
Write final surface to grid file [Yes/<No>]? press Enter
Trim existing contours inside pad perimeter [Yes/<No>]? Y
Retain trimmed polyline segments [Yes/<No>]? press Enter
Contour the pad [<Yes>/No]? N

We then repeated the above steps for the pad on the right, except this time, we entered 1964 for the pad elevation. The results are shown below, in 2D and 3D views.

B. Draw->3D Polyline (Tool 2)

This is an obvious tool for creating terrains. Before drawing the polyline, try Viewpoint 3D under the View pulldown, and choose a SW viewing angle at 35 degrees above the XY plane to get a view similar to the 3D graphic shown above. In this view, erase the original pad base polyline, which is still at an elevation of 0.00. This will prevent the "nea" snap from finding the 0 elevation base polyline instead of the new, green, pad polyline. Enter Plan at the command prompt, followed by two Enters, to go back to Plan View. Now, we want to draw the polyline as shown below. We recommend the use of Carlson's 3D Polyline, found near the top of the Draw pulldown menu. We want to build a ramp from north to south into the pit. We will "arbitrarily" start at elevation 1978 by "snapping" to the 1978 contour with the "nea" snap (nearest), and then snap to the base of the pit at 1950 with the nearest snap. In the following steps, we will offset this 3D Polyline, connect its ends by Join Nearest, and create a pad template with 2:1 side slopes.
C. Edit->3D Polyline Utilities->Offset 3D Polyline (Tool 3)

After the 3D Polyline is drawn, do the Inquiry command *Angle & Distance*, Linework option, to check the percent slope of the 3D polyline. At approximately 10% grade, it should be "drivable" by haul trucks. Now, use the Edit > Copy > *Standard Copy* command and make a copy of the polyline, placing it to the right. You will want to use the Polar Tracking to ensure that the second 3D Polyline also contacts the base of pit.

D. Edit->Join Nearest (Tool 4)

Now find *Join Nearest* under the Edit pulldown menu. Select Directly Connect Endpoints, and enter a 35 offset tolerance. Pick both 3D polylines to join them, as shown in the graphic.

E. 3D Polyline Closed Perimeter

Now we have a 3D polyline closed perimeter, which can act as a pad. It is advisable to first do a *List* command, under Inquiry, to verify that each pad vertex is non-zero. Now, pick the *Design Pad Template* routine under the Surface menu. We will no longer be asked for a pad elevation, since the program will obtain the variable pad elevation from the vertices of the 3D polyline. Accept the default settings, and pick a window that encompasses the whole pad.

Enter the fill outslope ratio <2.00>: press Enter
Enter the cut outslope ratio <2.00>: press Enter
Calculate earthwork volumes [ <Yes>/No]? press Enter
Review the report, and then Exit from it.
Adjust parameters and redesign pad [Yes/<No>]? press Enter
Write final surface to grid file [Yes/<No>]? press Enter
Trim existing contours inside pad perimeter [Yes/<No>]? Y
Reading the selection set ...
Retain trimmed polyline segments [Yes/<No>]? press Enter
Contour the pad [ <Yes>/No]? N

The 2:1 cut side slopes (fill side slope is irrelevant, since we are in cut) leads to the drawing shown in the graphic.

Note that we are consistently using *Design Pad Template* to trim existing contours and 3D polylines, and to not retain the trimmed portion. We are also consistently selecting not to draw contours. In this manner, we iterate our way to the desired final terrain. We should also note that we are using the standard 50x50 "number" of cells in the Pad Template routine, windowing the entire site each time. More cells or smaller dimensioned cells lead to a finer calculation.

F. One-Sided Pad Template

![Diagram of pad with contours](image-url)
Design Pad Template in the Surface pull-down menu also works with a 2D or 3D polyline that is open and not closed. In this case, the routine will ask for which side to offset (with a closed polyline, it always offsets outward). For example, suppose you were concerned where a pit located along the northeast side of the site would "catch" if it sloped at 2:1 from an elevation varying from 1980 at the north end to 1985 at the south end. To put this 3D Polyline in, select 3D Polyline under the Draw pulldown menu, and choose the prompt for elevation option. Enter the north elevation as 1980 and the south elevation as 1985. Then do Design Pad Template and choose the left side for the offset at 10:1.

The top of the cut did not impact the building pad or the parking lot.

II. Bench Pond (Tool 5)

A. Fully "Incised" Pond

Here we have drawn a closed polyline in the lower right of the drawing, and will set its elevation to the lowest elevation the line crosses (as prompted by the program). This will ensure that the pond is fully incised and does not have any fill slopes. The Design Bench Pond routine is found under the Surface pulldown menu (make sure that you are working in the Civil Menu). It is based on the use of the closed polyline representing the top of the pond. The program cuts a circular pond into the existing terrain.

Unlike Design Pad Template, the Design Bench Pond routine works "inward". The main thing to remember is that if you have roughly 20 feet to the center of the pond, and you want to go downward at 2:1, do not ask for a depth greater than 10 feet. This will cause one side to pass beyond the other, and you will "hourglass" the interior. Another concept to remember is that the program will cut downward from the drawn polyline, which is placed at an elevation representing the water level or top of pond. A separate cut and fill ratio can be applied to the outside of the drawn polyline. If you place the pond fully in cut (fully incised), then one cut ratio would apply to the interior going down to the base of pond, and another would apply to the exterior going up to "daylight". Of course, the same ratio can be entered for both slopes.

B. Partial Fill-Partial Cut Bench Pond

A typical farm pond might have the downhill side in fill and the uphill side in cut. In fill, the flat-topped "bench" might be 10 feet. In cut, the bench would disappear. Cut above water into original ground might be 6:1. Cut below water might be 3:1. Fill could be set at 6:1 and 3:1 below water. In this case, we would remove the top bench in cut. The graphic shown here is a bench pond cut into the top center of the drawing at elevation 1994.
C. Revisit Pad Template by Doing a Diversion Ditch

If you are getting the idea, try this on your own:

Draw a 3D Polyline that will drain the lower right pond into the upper left pond. Do this through use of the *3D Polyline* command, under Draw. Issue the command, and use a "nea" snap maybe one-third down the northwest "slope direction line" in the pond at the lower right of the graphic. Connect using a "nea" snap to a point halfway down the southeast running "slope direction line" in the pond at the upper left of the graphic.

List your 3D polyline to be sure it runs downhill from approximately 1992 to 1989, or thereabouts. We're only after the concept here. Then do *Offset 3D Polyline* four feet either way for base of ditch. Connect the ends up with *Join Nearest*, tolerating 5' separation. Then do *Design Pad Template* at 3:1 side slopes in Cut and Fill. Your result is shown in 3D.

III. Valley Pond

A. Constructing a Valley Dam (Tool 6)

To begin this exercise, reopen the original example2.dwg file. We can "carve out" another portion of our base map by first drawing a "Rectang" in the SW corner of the map as shown below. Then choose *Erase by Closed Polyline*, under the Edit pulldown, selecting the rectangular perimeter and checking Erase Outside. If you'd like, you can freeze the BORDER layer to clean up your drawing. To preserve the original example2.dwg file, do a Save As under a new filename, such as valley1.dwg.

Unlike *Design Bench Pond*, the *Design Valley Pond* routine requires only a polyline axis line for the center of the dam. The polyline can be a 2-point polyline, or it can have several vertices along its length to create a concave or convex dam structure. The main thing is to "overdraw" the axis polyline, make it ride up on the left and right hillside, well beyond the desired top of dam elevation. This allows the routine to look inward and find the extents of the dam.
on each hillside, without doing an artificial extension of the polyline. Just "overdo" the length of the axis line and you are in business.

Another aspect to concentrate on is the desirability to select enough terrain upstream to enable the program to compute the full waterline extents - the limits of the dammed-up water. Without enough upstream terrain in the initial selection set (which acts like a crossing selection), you will not be able to compute the limits of the water surface and the pond stage-storage information.

Our axis polyline runs from approximately 1960 on one side of the valley to 1960 on the other. It crosses the valley at 1931. Let's decide to put the top of dam at 1950 even. We will make the dam 20' wide, with 3:1 downstream and 4:1 upstream slopes. Select Design Valley Pond under Surface > Design Pond. Source of surface model is, as always in this case study, the screen, so create a window around our new polyline, then click somewhere within where the pond will be. Respond to the prompts as shown below.

Source of surface model [File/<Screen>]? press Enter
Pick Lower Left limit of pond disturbed area: pick the lower left location of the valley pond region
Pick Upper Right limit of pond disturbed area: pick the upper right location of the valley pond region
Pick the top of pond polyline: pick the polyline that represent the centerline of the dam
Enter slopes as percent grade or slope ratio [Percent/<Ratio>]? press Enter
Enter the outslope ratio <2.00>: 4
Enter the interior slope ratio <4.00>: 3
Enter the top of dam width <10.0>: 20
Enter the top of dam elevation: 1950
Side Polyline Spacing <10.0>: press Enter
Cut pond interior [Yes/<No>]? press Enter
Calculate stage-storage values [<Yes>/No]? N
Output grid file of final pond surface [Yes/<No>]? press Enter
Adjust parameters and redesign pond [Yes/<No>]? press Enter
Trim existing contours inside pond perimeter [Yes/<No>]? Y
Retain trimmed polyline segments [Yes/<No>]? press Enter
Contour the pond [<Yes>/No]? N

B. 3D Polyline by Slope on Surface (Tool 7)

How would you start at the top of dam (elevation 1950) and build a road running downhill at 6% grade? Or, in general, how would you obtain 3D polylines for roads and diversion ditches that follow the terrain at prescribed grades starting at desired points?

The answer is 3D Polyline by Slope on Surface (located under the 3D Data menu, within the 3D Polyline Utilities pulldown). This routine requires that we make a grid or triangulation file for the terrain. Use the command Make 3D Grid File under the Surface pulldown menu, and store the file as Dam.grd. Under Grid Position/Resolution, select
Screen Pick and specify a 20x20 cell dimension. Draw a window that encompasses the entire drawing, and pick all points and lines. Then run the 3D Polyline by Slope on Surface command and answer the prompts as follows:

**Enter the polyline layer** `<SLOPE_PLINE>`: press Enter
Select Dam_grd as the grid file to use.
**Limiting length for polyline (Enter for none):** press Enter
**Pick origin point of 3D polyline:** pick a starting point on the north side of the dam
**Direction of 3D polyline [Up]/[Down]?** D
**Direction of 3D polyline facing down slope [Left]/[Right]?** R
**Slope format [Percent]/[Ratio]/[Degree]:** press Enter
**Enter design slope percent:** 6
**Pick origin point of 3D polyline (Enter to end):** press Enter

After the new 3D polyline is drawn, offset it into the hill with the Offset 3D Polyline command (under 3D Data > 3D Polyline Utilities). Press Enter for the defaults when prompted, but make sure to use a horizontal offset of 20, and a vertical offset of 0 to define the road. Then join the ends with Join Nearest, and you should obtain the drawing shown here.

Now we want to use Design Pad Template to carve our road into the terrain. In the drawing showing text information at the upper left, we can see that we now have a "pad" for pad template. Because the southern side of the pad follows close to the original ground, it may "cantilever" over into the "air" in a few places based on the resolution of the calculation. It is recommended that the fill ratio used to catch the ground be low, such as 1:1 rather than 2:1, so that short cantilevered sections of the pad, if placed on natural 2:1 terrain, don't "skim" over the ground and create unnecessary fill. For the cut sections, we will use 3:1 to carve the road into the solid hillside. The result can be seen in 3D.
C. 2D to 3D Polyline by Surface Model (Tool 8)

The 3D view above reveals a 3D polyline running up the base of the stream channel in which the pond was built. Such 3D polylines are important in modeling accurate surfaces for pond design, pad templates and volumes in general. For example, if you were to triangulate and contour the valley at 1’ interval (currently the contours are at 4’ interval), you would obtain poor valley contours which "square off" in the valley - if you did not select the 3D Polyline “break line”.

Thus, an important strategy, better yet policy, is to dress up raw contour maps with valley and ridgeline 3D polylines that act as break lines, and restore the true character of the terrain. The best way to make these 3D polylines is to draw 2D polylines in drains and ridges (see the three circled examples) and "drape" them on the terrain. This is done using the 2D to 3D Polyline by Surface Model command, found under the 3D Data pulldown menu. You can use the Dam.grd file that you created earlier.

D. Creative Uses of 2D to 3D Polyline by Surface Model

More than a command to "dress up" contour maps for greater modeling accuracy, the 2D to 3D Polyline by Surface Model command (sometimes called the "drape" command) has unexpected uses. In the example, a strata angling along a pit face creates instability in the upper part of the pit. The goal is to "lay back" the pit at 2:1 above the strata demarcation line, and retain the 1:1 slope below that line (which is drawn as a 2D polyline at the outset, then converted to 3D when draped).
After the 3D Polyline is "draped" on the surface, you should use Change > Elevations under the Edit menu to drop the entire 3D Polyline just a little, such as -0.2. This will ensure it is fully in Cut. Then the Design Pad Template command can be used to perform a one-sided offset at 2:1 in Cut, resulting in the drawing, shown here in 3D view.

E. Input-Edit Profile (Tool 9)

Our next goal is to build a diversion ditch around the dam using Input-Edit Profile. With Osnaps turned off, draw a simple 2D polyline ("PL" command or Carlson's "2DP") that starts on the water side of the valley dam, near the "break line" that was drawn earlier, and curves around the hill to the south and into the drainage below the dam, as shown in the graphic. The syntax for this using the PL command is: pick first point, pick second point to get a tangent (straight section) going, then type A for arc, arc it around the dam, then do L for line and a second L for length, and pick a point that comes off tangent from the arc and ends in the stream bed below the dam. Then press Enter to exit the PL command.

Now we are going to make this 2D polyline a 3D polyline with a prescribed profile. To prepare for this, we do Polyline Info under the Inquiry pulldown menu, and write down the length of the polyline (this will become the length of the profile we enter). This one here is 377.6 feet, which we will round up to 378. We then use List Elevation under the Inquiry pulldown menu, and pick on the 3D "break line" polyline as close as we can to the point where our 2D polyline makes contact. In our example, this elevation is reported as 1929.4 (along with all vertices elevations). We determine ahead of time that we want the first 50 feet of the diversion ditch to be a 1% downhill slope, starting at elevation 1946 (allowing 4 feet of freeboard to the top of the dam at 1950). We are ready for Input-Edit Profile File in the Profiles menu. Call it Ditch.pro, and fill out the profile dialog as shown in the graphic, but with the data that applies to your example.
The order of entry might be 0 and 1946 on the first line, 378 and 1929.4 on the third line, and 50 and slope% of -1 on the second line, completing the profile. Save it, and Quit from the dialog. The one remaining step to get a 3D polyline is to select the command Profile to 3D Polyline under the Profiles pulldown menu. Pick the ditch centerline and apply the newly saved profile to it. Erase the old centerline and you obtain a "yellow" colored 3D polyline centerline.

Use the command Offset 3D Polyline to offset the ditch into the hill 8 feet for an 8’ base (or offset 4’ either way and erase the original centerline). In either case, you have two parallel 3D polylines. Now, do Join Nearest, tolerate 9’ of separation and Directly Connect Endpoints within Join Nearest.

Note how 3D Polyline > Offset 3D Polyline and Join Nearest become a familiar sequence in doing pad template work! Now create a Design Pad Template with a cut slope of 1.5 to 1.

If it is apparent that the diversion ditch was initially drawn too far into the pond area and created fill, as seen in the graphic, then there is the option to re-design or simply to trim off the fill portion. This likewise applies to the portion of the diversion ditch at its terminus downstream. Note that gaps in contours that need to be re-closed can be very quickly fixed with Join Nearest. With the trimming completed, the final design appears in 3D.
F. Profile to 3D Polyline (Tool 10)

Our next topic of discussion will focus on building a curving road from the top of dam to the base of pit using Input-Edit Profile and converting that profile to a 3D Polyline. Looking at the 3D view in the graphic, let's extend the road from the top of dam into the base of the pit, following a uniform grade and entering the pit at right angles on the south side (or right-side, as seen in the graphic). This "word problem" is nothing more than another iteration of Input-Edit Profile File and Profile to 3D Polyline. The first challenge is to draw the 2D polyline using the PL command. We've already learned how to do this and use the second L approach to come off tangent from an arc. We end up with a centerline that might look like the one in the graphic.

Just as before, find the length of the polyline using Polyline Info under the Inquiry menu. We know the profile... it runs from 1950 (the top of dam) down to 1930 in the base of pit. So we go straight to Input-Edit Profile File, perhaps name it Road (Road.pro) and put in a simple two-entry profile as shown in the dialog box display here.
The slope of the road at -3.17 percent is very acceptable for any type of vehicle. So now we choose Profile to 3D Polyline and apply Road.pro to the road centerline. This time we will offset the new 3D polyline 10 feet either side using 3D Polyline Offset, and erase the original middle centerline (or render it harmless for terrain modeling by the command 3D Entity to 2D found under the Edit menu).

This raises an important point: when we select entities from the screen using Design Pad Template, Design Valley Pond and Design Bench Pond, the pad or pond polyline itself is filtered out of the selection set, and it is not used for modeling the original surface.

If we left intact a 3D polyline centerline that was not part of our pad, it would skew the surface model badly. Thus, if we offset left and right for the outside of the road, the middle of the road must go, must be erased, unless we chose the "grid file" option for the original surface. After offsetting 10' either side and erasing the center 3D polyline, we Join Nearest at a 21' tolerance. Then we do Design Pad Template at standard 2:1 slopes.

Here is the final 3D view (you might use Design Pad Template to divert the ditch and not flood the pit!).

IV. Pad Template in Combination with Design Template for Roads, Ditches, and Levees

A. Roads with Ditches and Berms

The limitation of Offset 3D Polyline within Pad Template is that roads cannot easily be given dynamic characteristics: They won't automatically carve in ditches in cut, or build a berm in fill where fill exceeds a certain threshold,
for example.

Since these "intelligent" features exist within the Design Template routine in the Roads menu of the Civil Design module, all we need to do is invoke the "template" option within the Pad Template. Pad Template will then go out and get a Design Template and apply it to the one-sided or closed pad perimeter. To illustrate this, let's first make a centerline that will have cut and fill. Consider the centerline drawn in the graphic.

If we go a uniform grade from the existing road, upward to the ending elevation (which might represent a mining bench), we are "bound" to get cut as we cross the lower point and fill as we cross the second drain. To "guarantee" fill, we will go uphill early and lessen the last portion of the grade, using a vertical curve length of 500 between profile grades. This is another exercise of Polyline Info (for length), verifying start and end grades, and Input-Edit Profile (as shown in the dialog).

With the profile input (named road1.pro), we can select Profile to 3D Polyline and turn yet another 2D polyline into a 3D polyline. The difference now is that we will not offset the 3D polyline to create a closed, looping "pad". We will instead use a template made in Design Template, and apply it to the 3D polyline.

B. Entering a Template in Design Template (Tool 11)

Design Template, located under the Roads menu in the Civil Design module, is icon driven. Create a new template, you may call it Roads1. See this horizontal strip of icon options.
Shown here is a selection of dialogs that illustrate our entry of a 24' wide road (12' either side) at 2% slope, no shoulder, no subgrade, a 3:1 slope for 6' to the base of ditch, a conditional cut upslope, a 3:1 slope in fill, but a 2:1 berm in fill, rising 4 feet, used when fill exceeds 5 feet. To begin with, this small dialog appears when the Grades button, within the Design Template dialog box, is clicked.

Note that when you are putting in a ditch, you need to click "Add Ditch" at the lower-left of the Cut Grades dialog. The conditional cut upslopes mean 4:1 up to 4 feet of fill, 3:1 between 4 and 10 feet of fill and 2:1 above 10 feet of fill.

The Fill Grade dialog looks similar, with two entries for berms (Add Berm is selected twice), one for upslope at 2:1 for 8 feet (which translates to 4 feet vertically) and a second for downslope of 2:1 for 8 feet for the back of berm.
The “typical section” can be drawn using the command *Draw Typical Template* under Roads. This will help you verify the quality of your template. Our template is shown here.

**C. Design Pad Template (Tool 12)**

Now let's use the *Design Pad Template* routine, found in the Surface menu. The dialog box for *Design Pad Template* is filled out as shown.
For the first time, we have selected the "template" option under Design Slope Format.

Finally, here is how the road appears in 3D using the View > Viewpoint 3D command.

This completes the Lesson 8 tutorial: A Dozen Tools for Surface Design.

**Lesson 9: Calculate Volumes By Five Methods**

For this tutorial, we'll be using a sample stockpile drawing and calculating its volume using five distinct techniques.
1. **Stockpile Volumes:** Creates grid surfaces from perimeter polyline and surface entities and calculates volumes in one command

2. **Two Surface Volumes:** Calculates volumes between two grid files

3. **Volumes By Layers:** Creates grid surfaces from existing and design layers and calculates volumes in one command

4. **Volumes By Triangulation:** Calculates volumes between two triangulation files

5. **Calculate Sections Volumes:** Calculates volumes between two section files using volumes by average end areas

Each of these routines has its own advantages. You can choose the routine that best suits your data or run multiple methods as a check of the volumes. The volume reports for each of these routines will vary slightly due to using different types of surface models that have different resolutions. These volume differences should be less than 2%.

A Results Summary of the various volume methodologies is also provided.

If there is a greater difference, try increasing the resolution of the surface models. For grids, make the grid cell size smaller and for sections, make the station interval smaller. If there is still a significant difference, then the cause should be investigated by checking the source data.

**Common Steps**

The following are common preparation steps for all five volume methods.

**Step 1 - Open Drawing and load Civil Module:**

From the File menu, choose Open and select example1.dwg from the Carlson Projects folder (e.g. C:\Carlson Projects\example1.dwg). Then load the Civil Module menu by running Settings->Carlson Menus->Civil Menu.

**Step 2 - Draw Perimeter (the automated process):**

There are several methods for drawing the perimeter polyline. One such method involves using the CRD (or Field to Finish).
The Surface > Stockpile/Pond/Pit Volumes > 3D Poly Perimeter command can draw by point numbers from the coordinate file. If you have the coordinate file for the points, then you can go directly to draw and use the point numbers. In this example, we have only the drawing and no coordinate file. Still, we can easily create a coordinate file from the points in the drawing.

First run Points > Set CooRDinate File, and in the file selection dialog, choose the New tab and enter example1 for the file name. Next run Points > CooRDinate File Utilities and pick Update CRD File From Drawing. Go with all the defaults for this function and when prompted to select objects, enter All. Now the coordinate file has all the points from the drawing. In this example, the perimeter points are sequential. So at the 3D Poly Perimeter command prompt for points, you can enter the point range of 2000-2028 and it's done.

Step 2 - Draw Perimeter (the quick process):

One of the signature commands found in Carlson Software is the Shrink-Wrap Entities found under the Draw menu. This routine is useful in situations where outlying perimeter locations don't share the same point descriptions, aren't sequentially numbered and is used even if the outlying locations are not points! Let's explore this routine by clicking the Draw > Shrink-Wrap Entities command. Set the parameters in the dialog as shown here.

The resultant perimeter should resemble that as shown in the illustration shown in the next discussion item.

Step 2 - Draw Perimeter (the manual process):

We begin by drawing a perimeter polyline using the outermost points of the stockpile. The perimeter polyline limits the volume calculation to the area within the polyline. In this example, the perimeter polyline consists of points 2000 - 2028 with description B-TOE. To pick these points, set your osnap to Node using the Object Snap under the Settings pulldown menu and turn off all the other osnap methods. Then run Draw 3D Polyline.

Pick all the perimeter points one at a time. At the command line, the program will prompt as follows:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick point 2000, a B-TOE point
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: pick point 2001, pick the next B-TOE point
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: pick point 2028, pick the last B-TOE point

... [Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: press C to close the perimeter and exit the routine.

After you draw your perimeter polyline, simply return your osnap to none.
Volume Method 1 - Calculate Stockpile Volume

Step 1 - Calculate Stockpile Volume:

The Calculate Stockpile Volume routine is based on a grid surface methodology like Two Surface Volumes discussed below. The difference with this routine is that it builds the grid surfaces within the routine to save time otherwise needed to build the grid files. The fewer steps make this routine faster and easier but it doesn't have options for checking surfaces. Instead the input data entities should be checked before running this routine. Also, Calculate Stockpile Volume only applies to volumes calculations when the volume is all fill.

NOTE: For situations involving a Cut-only scenario (such as a pond or pit), use the Surface > Stockpile/Pond/Pit Volumes > Calculate Pond/Pit Volume command.

Choose Calculate Stockpile Volume from the Surface menu, under Stockpile/Pond/Pit Volumes. The routine starts with prompts at the command line.

Material density lbs/ft\(^3\) (Enter for none): press Enter

This density option applies when you're measuring a stockpile of a material with a known density and you want to report the material tons for the stockpile.

Ignore zero elevations [Yes/No]? press Enter (filters out elevation zero entities)

Select stockpile entities and perimeter.

Select objects: All

Select objects: press Enter

The program looks for a closed 3D polyline on the PERIMETER layer to use as the inclusion perimeter and the base surface model. If this polyline is not found, then the program will prompt to select the perimeter polyline. All the selected entities including the perimeter are used to model the second surface of the stockpile top.

Specify the grid resolution as shown in the dialog below.
Next you have the option to break up your volumes report by a specified interval. In this example, let's do every 5 feet.

The volume report displays.

NOTE: The limits of the grid are determined automatically and shown in the report. For the sake of accuracy, the next two methods will use the grid parameters shown above.

**Volume Method 2 - Two Surface Volumes**

**Step 1 - Make Base Grid Surface:**

Before running *Two Surface Volumes*, we must create the two grid files by using the *Make 3D Grid File*, located under the Surface menu. The first grid file will be for the base of the stockpile. At the file selection Grid File To Create dialog, enter a name of BASE and click Save.
Next, there is a dialog to set the grid parameters. The Low and High elevations are used to filter out elevations outside the range. By default the Low elevation is set to 1 which filters out zero and negative elevations. For the Modeling Method, use the default Triangulation method for surface models. The other methods are primarily for strata geologic models. For Triangulation mode, the Triangulation Only method triangulates all the data points. The Triangulation with Subdivision does the Triangulate step followed by subdividing the large triangles to make a smoother surface. The Intersection Only method interpolates the grid corners from the intersections of the grid lines with the surface linework which applies to making a grid from all contour polylines. The Auto Detect method looks at the source data and chooses Intersection if all the data is linework or uses Triangulation otherwise.

The grid resolution sets the size of the grid cells either by entering the actual size or by the number of cells. Generally, you should use a grid size that is small enough to pick up the changes in the surface. At the same time, the total number of cells should be less than a million depending on your computer memory. In this example, we have 50x50 cells which results in a cell size of 4.82 in X (Easting) and 3.92 in Y (Northing), and this is enough resolution for the data.

Lastly, check the *Screen Pick* option under Set Grid Position, and then click OK.

To select the grid position from the screen, create the rectangular area for the grid surface that completely encloses the stockpile.
Next, examine the prompts below to use for the model. For the base surface, select only the 3D perimeter polyline.

**Pick first grid corner:** *pick the first grid corner as illustrated*

**Pick opposite grid corner:** *pick the second grid corner as illustrated*

**Select points, lines, polylines and faces to grid from.**

**Select objects:** *pick the 3D perimeter polyline (again)*

**Select objects:** 1 found

**Select objects:** press Enter

**Step 2 - Make Final Grid Surface:**

Next, let's create the top of the stockpile surface by repeating *Make 3D Grid File* used in the last step. Choose *Make 3D Grid File* from the menu and enter a grid file name of FINAL in the file selection dialog.

In the dialogue under Set Grid Position, check the *From Another Grid File* method and select BASE.grd as the reference grid position. This file method uses the grid position and resolution from the selected reference grid. For Two Surface Volumes, the two grids to compare should have matching grid positions and resolution.

Then there are a series of command line prompts for the elevation range and modeling method. Press Enter for each of these prompts to go with the defaults. Then for the selection of objects to process, enter All to use the stockpile perimeter plus all the points.

**Select points, lines, polylines and faces to grid from.**

**Select objects:** *All*

**Select objects:** press Enter

**Step 3 - Check Surfaces:**

This step is optional to verify that the surfaces are good by checking for bad elevation data points and that the surfaces follow the data points. There are several routines that can be used to check the surfaces, including Draw 3D Grid File, Surface Inspector and Contour From Grid File. For this example, we will use Draw 3D Grid File and Surface Inspector.

In the Surface menu, under Draw Surface, choose the *Draw 3D Grid File* command. At the Select Grid File dialog, choose FINAL.grd. In the options dialog, go with the settings shown here and pick OK.
With the grid drawn as 3D Faces, run the 3D Viewer Window command in the View menu. At the command line, it will prompt to select the objects to view. Enter All and press Enter.

Select all entities for the scene.
Select objects: *All*
Select objects: *press Enter*

In the 3D Viewer dialog, move the pointer near the center of the graphic and the cursor will change to an X/Y symbol which is the X/Y axis rotation mode. Click down the left mouse button and drag down to rotate the pile to a good
viewing angle. Then move the pointer near the edge of the graphic and the cursor will change to a Z symbol which is the Z axis rotation mode. Click down the left mouse button and drag around to rotate the pile. You can also set the Vertical Scale to 2.0 and choose the Color By Elevation toggle for better viewing of the elevation difference.

The surface looks right in the 3D Viewer. Close the 3D Viewer by choosing the Exit Door button. We don't need the 3D Faces anymore. Let's delete them by running *Erase By Layer* in the Edit menu. Choose the Select Layers From Screen and pick any 3D Face. Then pick the OK button.

![Erase by Layer/Type](image)

The Draw 3D Face check could also be run on the BASE.grd surface using the same procedure as above, but we're going to skip that in this tutorial to save space.

Now, let's check using Surface Inspector. First, use Zoom Window under View to zoom onto the bottom of the pile so that we can easily read the point elevation labels. Then run Surface Inspector from the Surface menu. In the dialog, set BASE.grd and FINAL.grd as the two surfaces to inspect and then pick OK.

![Surface Inspector](image)

Now, move the pointer around the pile and the program reports the elevation of the two surfaces in real-time. Check that the grid elevations match the point elevations reasonably well. Remember that the base elevations are using only the B-TOE points. The elevations won't match exactly with grid surfaces because the grid model is at the resolution...
Step 4 - Two Surface Volumes:

Now that you have your base file and final grid files, to calculate volumes use the Two Grid Surface Volumes command in the Surface menu, under the Volumes By Grid Surface flyout.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: select the perimeter polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select Base Grid File Choose BASE.grd
Select Final Grid File Choose FINAL.grd

Set the Volume Report Options dialog box as shown above and click the OK button. A volume report similar to that shown below is produced. Note that your volume totals may vary slightly due to the orientation of your grid.
Volume Method 3 - Volumes By Layers

Step 1 - Volumes By Layers:

Like the two previous volume methods, Volumes By Layers is based on grid surfaces. Similar to Calculate Stockpile Volume, this routine builds the grid surfaces within the routine to save the steps of running Make 3D Grid file. The difference between this routine and Calculate Stockpile Volume is that Volumes By Layers uses entities on the specified layers for existing and design to build the surfaces and it will calculate both cut and fill volumes.

Choose Volumes By Layers from the Volumes By Grid Surface flyout of the Surface menu. The routine starts with prompts to set the grid area to model. In the same way as the Make 3D Grid File step of Two Surface Volumes, pick two corner points that make a rectangle to enclose the stockpile area.

Pick Lower Left grid corner: pick to the lower left of the stockpile
Pick Upper Right grid corner: pick to the upper right of the stockpile

Next, there is a dialog to set the grid resolution. Again, the same rules for grid resolution apply as described in the Two Surface Volumes step.

In the next dialog, set the layer names for the entities to use for the Existing (Base) and the Final (Design) surfaces. For this example, pick the Select Layers From Screen button under Existing and then select the perimeter polyline. Then pick the Select Layers button under Final and select both the perimeter polyline and the points.
After specifying the layer names, click OK in the dialog. Then the program prompts to select the surface entities to model. For this example, type All and press Enter to process all the entities. The program will sort the entities for modeling of the existing and design surfaces by the layer names.

Next, you specify the inclusion and exclusion perimeters. For the stockpile, pick the perimeter polyline for the inclusion and press Enter for none at the exclusion prompt. The same Volume Report Options dialog then offers the same output options as Two Surface Volumes. Click OK. After this dialog, the report is displayed.

Select surface entities on corresponding layers.
Select objects: All
Select objects: press Enter
Select the Inclusion perimeter polylines or ENTER for none.
Select objects: select the perimeter polyline
Select objects: press Enter
Select the Exclusion perimeter polyline or ENTER for none.
Select objects: press Enter
Volume Report Options dialog Pick OK

Volume Method 4 - Volumes By Triangulation

Step 1 - Triangulate & Contour for Base:
Before running Volumes By Triangulation, we need two triangulation surface files to compare. From the Surface menu, choose Triangulate & Contour which brings up the Triangulate & Contour dialog.

Under the Contour tab, turn off Draw Contours. Actually, drawing the contours at this step can be a good visual check that the surface is right but we’re going to skip it this time. Under the Triangulate tab, turn on Write Triangulation File, Use Inclusion Perimeter and Ignore Zero Elevations. Then pick the Browse button and set the file name as base.tin. When the dialog is set as shown, pick OK.

Next, the program prompts for the inclusion and exclusion perimeters. Choose the perimeter polyline for inclusion and nothing for exclusion. Then you select the entities to triangulate. For the base surface, pick only the perimeter polyline and then press Enter.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: pick the perimeter polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select the points and breaklines to Triangulate.
Select objects: pick the perimeter polyline
Select objects: press Enter

Step 2 - Triangulate & Contour for Stockpile:

To create the second surface, repeat step 1 with a few simple changes. In the Triangulate, choose Browse, and set the file name to FINAL.tin and then pick OK.

For the inclusion and exclusion perimeters, again choose the perimeter polyline for inclusion and nothing for exclusion. At the select objects prompt, enter All and press Enter to use all the points and the perimeter to make the stockpile surface.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: pick the perimeter polyline
Select objects: press Enter
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Step 3 - Check Surfaces:

Similar to the Check Surfaces step under Two Surface Volumes, this is an optional step to check that the surfaces are correct. Again, there are several routines that we can use. Let's check the surface file directly.

From the View menu, choose the **Surface 3D Viewer** command and open the **FINAL.TIN** file. Just as before in the **3D Viewer Window**, you are able to use the mouse click-and-drag methods to rotate the stockpile into view. Also, set the Vertical Scale to 2.0 and turn on Color By Elevations.

![Surface 3D Viewer](image)

Close the Surface 3D Viewer by choosing the Exit Door button. Notice how we didn't have to draw anything to the screen/drawing to check this surface!

Step 4 - Volumes By Triangulation:

Now that we have our two triangulation files, we can use **Volumes By Triangulation** which performs a TIN to TIN prismatical volume calculation. Of all the volume methods, this one is the most accurate since all the source data points are used in the volume model. **Volumes By Triangulation** is well suited for this example.

Run **Two Triangulation Surface Volumes** from the Surface > Volumes By Triangulation menu. For the Select Existing Surface File dialog, choose BASE.tin. Next, for the Select Final Surface File dialogue, choose FINAL.tin. Click OK. At the prompts for the inclusion and exclusion perimeters, pick the perimeter polyline and press Enter for None for the exclusion. In the Volume Report Options, go with the defaults and pick OK. Then the volumes are calculated and the report is displayed.

**Select Inclusion polylines.**
**Select objects:** pick the perimeter polyline
**Select objects:** press Enter
**Select Exclusion polylines.**
The volume report displays.

Volume Method 5 - Calculate Section Volumes

Step 1 - Draw Centerline/Baseline:

The first step for section volumes is to draw a polyline to use as the centerline for the section alignment. This centerline needs to be drawn so that the perpendicular section lines to the left and right of the centerline have a clear line to reach the perimeter without crossing and re-crossing the perimeter.

Before drawing the polyline, run *Aperture-Object Snap* in the Settings menu, and turn on only the Node snap.

Choose *2D Polyline* under the Draw menu. If the options dialog is shown, make sure that the elevation is set to zero and pick OK. Then at the command line, the program prompts to pick the polyline points.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick point 2027
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick point 2015
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
Step 2 - Define Section Alignment:

The next step is to define the station interval and left/right offsets for the sections. Choose *Input-Edit Section Alignment* from the Sections menu. In the Specify Section Alignment File dialog, choose the New tab and enter a file name of Vol-Sections.mxs, and click Open. The program then prompts for the centerline. Pick the centerline polyline that we just drew. For the starting station of the centerline prompt, use the default of 0.

*Polyline should have been drawn in direction of increasing stations.*

**CL File/<Select polyline that represents centerline>:** pick the centerline polyline  
**Enter Beginning Station of Alignment <0.00>:** press Enter

Next there is a dialog to set the section parameters. Set values as shown below and then click OK.
Select boundary polyline: pick the perimeter polyline

The program draws temporary lines in the drawing to show the positions of the sections. The next dialog shows a summary of the section alignment. Pick the Save button.

Step 3 - Create Section File for Base:

To create the section file for the stockpile base, run Sections from Grid or Triangulation Surface from the Sections > Create Sections from... menu. When prompted to Choose Grid or Triangulation file to process, open the BASE.tin file created earlier. When prompted to Choose Section Alignment file to process, open the Vol-Sections.mxs file. For the Section File to Write, save a new file called BASE.sct. On the final dialog for Link Sections to Triangulation, choose No.

Step 4 - Create Section File for Stockpile:

Let's follow similar steps to create the FINAL.sct file.

To create the section file for the stockpile itself, run Sections from Grid or Triangulation Surface from the Sections > Create Sections from... menu. When prompted to Choose Grid or Triangulation file to process, open the FINAL.tin file created earlier. When prompted to Choose Section Alignment file to process, open the Vol-Sections.mxs file. For
Step 5 - Check Sections:

Similar to the Check Surfaces steps under Two Surface Volumes and Volumes By Triangulation, we have a couple surface files. Before running the volumes, this is an optional step to check that the surfaces are correct. There are several routines to check sections including Input-Edit Section File, Draw Section File and Section To 3D Polylines.

For this check, run Input-Edit Section File under the Sections menu. For the Section file to process dialog, choose the FINAL.sct file. Next the Input-Edit Section File dialog is displayed. Pick the button labeled 2nd and choose the BASE.sct file. Then highlight station 0+94 (for example) from the Stations List and double click on it or pick the Edit button.

This brings up the Edit Station viewer for station 1+00. Use the Next and Prev buttons to look at other stations. After checking the stations, pick OK to exit Edit Station, and then pick Exit from the main dialog.
Step 6 - Calculate Section Volumes:

Now that we have our two section files, we can use Calculate Section Volumes, which does volumes by the average end-area method which is traditionally accepted for corridor studies.

From the Sections menu, choose Calculate Section Volumes. For the Existing Ground Section File, choose the BASE.sct file. For the Final Ground Section File, choose the FINAL.sct file. In the Calculate Section Volumes option dialog, use the defaults as shown.

Click OK. The volumes are calculated and reported, along with the cut and fill end-areas at each station.
Results Summary

As mentioned earlier, each volume methodology has a particular use and knowing the applications for each method will serve you well. Here is a summary of our results:

<table>
<thead>
<tr>
<th>Method</th>
<th>Fill (c.y.)</th>
<th>Cut (c.y.)</th>
<th>When to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockpile Volumes</td>
<td>2,656.51</td>
<td>-</td>
<td>Quick and approximate Fill-only volumes are sufficient</td>
</tr>
<tr>
<td>Two Surface Volumes</td>
<td>2,656.43</td>
<td>15.21</td>
<td>Large data sets when approximate Cut and Fill volumes are sufficient</td>
</tr>
<tr>
<td>Volumes By Layers</td>
<td>2,656.43</td>
<td>15.21</td>
<td>Quick and for large data sets when approximate Cut and Fill volumes are sufficient</td>
</tr>
<tr>
<td>Volumes By Triangulation</td>
<td>2,659.64</td>
<td>16.68</td>
<td>Large or small data sets when precise surface-to-surface Cut and Fill volumes are needed</td>
</tr>
<tr>
<td>Calculate Sections Volumes</td>
<td>2,659.69</td>
<td>16.68</td>
<td>Corridor studies where end-area averages are sufficient</td>
</tr>
</tbody>
</table>

This completes the Lesson 9 tutorial: Calculate Volumes By Five Methods.

Lesson 10: Basic Road Design with Volumes

1 First we need to open an example drawing supplied with Carlson. Issue the File Open command and choose EXAMPLE2.DWG. It should be in the Carlson Projects folder, and will look like the example (without the curved road).

2 Draw Road Centerline. Issue the Draw > 2D Polyline command and generate the road centerline shown below. If
the Polyline 2D Options dialog box appears, provide the values as shown below and then click OK.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 1857700,159400

[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: D

Enter distance: 310

Define direction method [Cursor/Line/<Angle>]: press Enter

Code: 1-NE 2-SE 3-SW 4-NW 5-AZ 6-AL 7-AR 8-DL 9-DR

Enter angle code (1-9) <7>: 1 (for a northeast bearing)

Enter bearing (dd.mmss): 68.5525

[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: A

[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: L

Specify radius length: 500

Curve direction [Left/<Right>]: press Enter

[Arc length/Chord length/Delta angle/<End point or point number>]: D

Specify delta angle (ddd.mmss): 76.2405

[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: L

<Enter or pick distance>: 1663.2721

[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter
3 Polyline to Centerline File. This step will create a centerline file necessary for the final road design routine. We will do the simplest variation, which is simply picking a polyline. There are other methods to design a centerline. They are documented in the manual.

First (if necessary), zoom back to the extents of the plan view, as we will be working with the polyline created above. Go to Polyline to Centerline File command, under Centerline, and name a *.cl file to create.

Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: pick polyline representing the centerline
Centerline station [Reverse/Ending/<Beginning: 0+00>]: enter

<table>
<thead>
<tr>
<th>Station</th>
<th>North(y)</th>
<th>East(x)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.000</td>
<td>159400.000</td>
<td>1857700.000</td>
<td>LI</td>
</tr>
<tr>
<td>310.000</td>
<td>159511.480</td>
<td>1857989.262</td>
<td>PC</td>
</tr>
<tr>
<td>976.728</td>
<td>159329.389</td>
<td>1858580.264</td>
<td>PT</td>
</tr>
<tr>
<td>2640.000</td>
<td>157961.527</td>
<td>1859526.534</td>
<td>LI</td>
</tr>
</tbody>
</table>

Press ENTER to continue. press Enter

4 Profile from Surface Entities. Now we will make a profile file, *.pro. This will be from the centerline shown in the drawing as the line with the curve. Under the Profiles menu choose Create Profile From... then Profile from Surface Entities. This will create a new file. Type in a file name in the dialog and click Save. On the next dialog, we will use the default values and click OK. Pick the centerline, and without hitting enter, select all of the contours. The data is written to file.

NOTE: Common practice is to build a surface model from any and all data that carries an elevation. However, there are several Carlson Create Profile from... routines and we'd like to work with a routine that gets its information "direct from the source" (i.e. the contours themselves).

5 Draw Profile. This will give us a profile view of the contours at our centerline. Under Profiles, go down to Draw Profile and add our new file to open. Click Ok.
The window below will appear as shown. With the horizontal scale set to 50 and the vertical scale set to 5, there will be a 10X vertical exaggeration of the profile. Fill this dialog box it out as shown below and click OK.

Next, there is the Profile Grid Elevation Range dialog. Accept the top and bottom elevations it gives by hitting OK. Pick a spot in the drawing to draw the profile, then view the profile on the grid by zooming as required. Your profile should look similar to this.
NOTE: The "flat spots" shown in this profile are the result of extracting the profile data directly from the contours. Extracting a profile from a surface model is a more common approach in today's computer age.

6 Design Road Profile. Now we will design how the road centerline profile will be, in relation to the existing ground (which is the first profile we have made). This routine will create another Profile file. Under Profiles, go to Design Road Profile, and then Design Road On Profile Grid (this method is suggested for this tutorial).

The following dialog box will appear. Since we followed up the Draw Profile command with this one, it was able to determine proper startup values for the dialog.

Choose OK on this dialog. A new file creation dialog box will appear, asking for an output file name. Enter a name such as DESIGN, and click Save.

Pick Lower Left Grid Corner <0.00,0.00>[endp on]: pick the lower left grid corner of the profile grid

Carlson has endpoint osnap active to make the pick accurate

At this point another dialog will appear in the upper left corner. Initially, it will display only station and elevation. Once a beginning point has been designated, it will also display the relative difference from the last point to the cursor position (illustrated below). This can be an aid in determining acceptable slopes for your design.
Enter a station or pick a point (Enter to End): \textit{END}
of pick the left-most endpoint of the existing ground profile as a tie in point

The following dialog appears. Choose OK to accept the defaults.

![Snap Profile Point](image)

Station of second PVI or pick a point (U,E,D,Help): 1111.01
Percent grade entry/\langle\text{Elevation of PVI}\rangle: 1999.37
Station of next PVI or pick a point (U,E,D,Help): 1911.64
Percent grade entry/\langle\text{Elevation of PVI}\rangle: 2002.66
View table/Unequal/Through pt/Sight dist/K-value/\langle\text{Vert Curve Length}\rangle: 500.00
For Sag with Sight Distance \rangle VC and Vertical Curve \rangle 500.00
Sight Distance \rangle 1000.0, K-value \rangle 306.6
Use these values (\langle Y \rangle/N)? \textit{Y}
Station of next PVI or pick a point (U,E,D,Help): \textit{END}
of pick the far-right endpoint of the existing road as a tie in point

The following dialog appears. Choose OK to accept the defaults.
For Sag with Sight Distance => 1000.00, K-value => 697.0
Use these values (<Y>/N)? Y
Station of next PVI or pick a point (U,E,D,Help): press Enter

At this point the following dialog appears. Change settings to match, and choose OK.

Pick vertical position for VC text: if prompted pick a point above the top of the grid

Carlson will now finish the road design, and your drawing should like the following:
7 Input-Edit Section Alignment. Now we will layout the alignment for our cross-section file. This step gives the section interval, and the offset left and right from our centerline. Under Sections, go to Input-Edit Section Alignment. Choose the New tab, which brings up the dialog to make a new MXS file (multi-xsection file). Type in a new name and click Open. Notice how all files can have the same name in this road design portion, as they all have a unique file extension. So for the organization of various jobs, it is sometimes helpful to have all of the files with the same name.

Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick the centerline polyline
Enter Beginning Station of Alignment <0.00>: press Enter

The dialog will appear as shown, enter in the stations and offsets exactly as they appear here. This will give the needed detail for the road design routine.

Choose OK, and another window appears that allows for any station editing or changes. It all looks good here, so hit Save.
The Alignment file is now written. There is now a preview of the section alignment lines shown on the centerline. These are just images, if the drawing is regenerated, they will disappear (they can be drawn permanently if desired).

8 Sections from Surface Entities. Next, we will create the actual section file (*.SCT) from the contours, in combination with the alignment file (*.MXS). Under Sections > Create Sections from..., go to Sections from Surface Entities. We will use the contours and breaklines for surface elevations, as we did with generating the profile. Specify the MXS file that we just created to read for the alignment. Click Open to select it. Then choose a new file name for the section file, and click Open.

We’ll enter in a distance of 1000 feet to add to our MXS limit of 70. This will search farther for contour elevations, then choose OK. Now, select the surface entities which are the contours and the breaklines. Once you are back to the command prompt, you are done with the making of sections.

9 Design Template. Let's design a wide boulevard, 30' of drivable pavement, with curb and gutter on the outside. Whenever a cut is within rock, the cut slope will employ a 0.5:1 slope rather than the typical 2:1 slope. At the top of rock, the cut will revert to 2:1. In fill, the condition will be 3:1 for fill under 6' and 2:1 for fill over 6' in depth. Pavement depths will be 8" of stone and 4" of asphalt.

First, Select Design Template, found under Roads, within the Civil Design module of Carlson. Click on the New tab.
We'll give it the same name as the drawing. Choose Open. A large dialog box appears as shown below. In it, you enter segments of the template, which work outwards from the middle as you add more lanes, curbs and shoulders. We will enter a symmetrical template, with 13.5' pavement sections either side of centerline, connecting to a 2' curb and gutter, with 18" of gutter and 6" of curb. Then we'll add a 6' shoulder.

For the lanes, click the Grades icon. This leads to a child dialog as shown next:
Fill out as shown. It's important to note that a downhill pavement from a crown in the middle is entered as a negative slope. That is, it is 2% heading from centerline outward, regardless of which side of centerline we are speaking of. Slope is in reference to the centerline of the template, and it is independent of the profile grade point. It is also important to enter an ID whenever requested. ID's can be referenced later.

A break point in a shoulder in superelevation could be defined as occurring at EP+3, as opposed to the exact offset distance from centerline. The advantage of EP+3 is that if the road lane width expands (e.g. for a passing lane), but the shoulder always breaks 3 feet beyond edge of pavement, then EP+3 is the only effective way to reference the break point. Now click OK. You'll note that the lanes show up in the preview window at the top.

Next, we will add a curb. Click the Curb icon. Fill out as shown:

It is especially a good idea to match crown – to make the curb match the slope of the last pavement lane (2% above). But if your curb tilts downward more (like 3%), then use a Special Base Slope Type. If it is flat, by all means click on Flat Base. Now click OK. Here's what our screen looks like so far:
Next, we will add a shoulder, going uphill at 4% for 8'. Notice what is happening. You are lit up on the Curb line, so if you add another Grade, it will append after the curb, and add to the back of the curb. If you were to click on the GRADE: 13.500, -2.000%, EP line, then click on GRADES, you would add a second lane before the curb, which is NOT what you want. Now click on GRADES with CURB: CB highlighted. Fill out the dialog as shown:

That's it for the surface! Here's what our screen looks like now: Note as you select the different items as you create them, the viewer window will highlight the selection.
Now we have subgrade and outslopes still to consider. Let's turn our attention to subgrade. Let's think about this: if our pavement is a total of 12'' deep (4'' asphalt, 8'' stone) and our concrete gutter is 6'' deep, then the stone will run 6'' deep under the gutter. Do we want this stone to come back up at the back of the gutter, behind the gutter, or even wrap around back into the gutter, like a layer of bedding that is covered by dirt? The most complex concept is the wrap around, so let's go for it.

Select the Subgrade icon. We'll do two subgrade surfaces: first asphalt, which will run straight out and hit the curb, and then stone, which will run out, go under the curb, and wrap back.

For any sub-grade, we still do the vertical offset as a negative distance (negative meaning down). But follow this concept: we start it out 13 feet from offset 0, and keep going at "Continue Slope" until it hits something (the curb). This won't work if there is nothing to hit. But it will run into the curb. Or if there is a fill slope, downhill 6:1 recovery zone lane, or something to intersect, it will also. This Continue Slope concept works perfectly for shallow asphalts and concretes that will bump into a curb, when extended.
Complete as shown above, and click OK.

Now for the other subgrade: the stone beneath the asphalt. Follow this: if the stone can't Match Surface (note this option under Slope Type), it will start uphill with the shoulder as it passes beyond the curb (it goes out 17'). So it must have a Special Slope Type, the same 2% all the way. The Wrap Height is the vertical rise at the end of the 17', before it wraps back and hits the curb. Select the Subgrade icon again.

Fill out the Sub-Grade Dimensions dialog as shown above and then click OK. Note the preview screen:
We still need to enter the outslope conditions. They are done with the Cut and Fill icons. Fill is easy in our example. Click on Fill.

Just 3 entries total: 3 (for 3:1), 6 (up to 6'), then 2 (for 2:1 over 6'). Click OK. Next, click the icon for Cut.
This is actually easier (in terms of total entries). Just 2 entries do it: 2 (for 2:1 normal cut) and down below, 0.5 (for 0.5:1 cut when in rock). Click OK.

The template is complete, so click Save, and then Exit the dialogue. Now let's prove we have a good template by doing the command Draw Typical Template.

10 Draw Typical Template. The file extension for templates will be tpl. Select Draw Typical Template under the Roads pulldown menu, select Example2.tpl (or as named above), choose Open and the following dialog shown here is displayed:
We have doubled the text scaler to 0.5 for better appearance in this tutorial. Click on Draw, and pick a starting position point. Here is the look of the plotted template.

Drawing Explorer. As more files are created, edited, loaded and reviewed within a work session, the drawing ini file takes note. You can review your active files as you work, or days later, because they save to the ini file that shares the same name as the drawing file. To see the files associated with this tutorial drawing file, select Drawing Explorer by sliding over from Project, under the File menu.
12 Input-Edit Section File. *Input-Edit Section File* has many uses. One of them is to translate or lower the elevations of a file and re-save. If we lower the elevations of our ground sections 8 feet, we can call that the rock line. Rock lines react with templates and profiles to create rock cuts and rock quantities, within the final step, which is called Process Road Design (Step 13). Select *Input-Edit Section File* under the Sections pulldown menu. Under the Existing tab section, select the SCT file you created earlier and click Open.

The next dialog that appears is shown below:
Click the Translate button. The Translate Selections dialog appears. The Ending Station might differ from what is showing here, but it should be close to this value. Make sure the rest of the dialog looks the same as shown below, and click OK.

Now back at the Input-Edit Section File dialog, click SaveAs, and enter a different name, such as Example2-rock, and save the file. Then click Exit.

Input-Edit Section can do much more through the Edit option. In the case of Edit, you would first highlight one station, then click Edit to review and revise it.

13 Process Road Design. This is the routine that weaves everything together. Select Process Road Design, as the lower command under the Roads pulldown in the Civil Design module. Fill out the dialog as shown below. Be sure to select, under Specify Output Files, the Design Section File option and click New. Enter a new file name and Save. Then click OK.
On the next dialog, be sure to click on Triangulate & Contour at the lower left of the dialog.

Now click OK. Here is a partial view of the final report, with itemized quantities:
Click Exit when finished reviewing the report. You will get this command prompt:

**Trim existing contours inside disturbed area [Yes/<No>]? Y**

**Retain trimmed polyline segments [Yes/<No>]? press Enter**

Here is the resulting graphic, in 3D, obtainable by using 3D View Window found under the View pulldown:

This completes the Lesson 10 tutorial: Basic Road Design with Volumes.

**Lesson 11: Road Rehabilitation**

This lesson designs a road rehabilitation project for two lanes of an Interstate highway. The top surface of the existing road has already been milled and the top of the milled surface has been surveyed. The two lanes are crowned in the
center with a typical cross slope of approximately 1%. The design is to add 8” of concrete with a minimum cross slope of 1.56%.

To begin, let's open the project drawing and verify the proper menu configuration is loaded.

1. Open the drawing named `rehab1_tutorial.dwg` installed in the Carlson Projects folder by default.
2. Make sure the Civil menu configuration is loaded. From the Settings menu, click Carlson Menus → Civil Menu.

Our goal in this section is to create an existing ground surface model named `Exist-rd.tin`. For input, there are survey points for the existing base and polylines for the centerline and edges of pavement.

1. From the Surface menu, click Triangulate & Contour and set the values shown in the dialog box below. Of particular note are the following settings:
   - `Write Triangulation File` is enabled with the file name specified.
   - `Use Inclusion/Exclusion Areas` is disabled.
   - `Shrink-Wrap Perimeter Reduction` is set to `Medium`.
   - `Ignore Zero Elevations` is enabled.
2. Click the OK button on the dialog box and follow the prompts below:

**Select the points and breaklines to Triangulate.**

**Select objects:** Type ALL and press Enter.

**Select objects:** press Enter

**Writing Triangulation File:** C: \ Carlson Projects \ Exist-rd.tin

This concludes the creation of an existing surface model of the milled roadway surface.

Our next task will be to create a horizontal centerline from polyline data found in the drawing. Before we complete this task, we'll want to freeze the **BREAKLINE** layer to expose the polylines on the **PROPOSED PAVEMENT** layer.

1. From the View menu, click Freeze Layer and follow the prompts:

**Pick entities on layers to be frozen.**

**Select entities:** Pick one of the pavement edge polylines and press Enter when complete.

**Freezing layer:** BREAKLINE

2. From the Centerline menu, click Polyline To Centerline File to create a CL file from the center polyline in the drawing.

3. Enter a file name of **rehab.cl**, pick the polyline and enter a beginning station of 73258.51.

Now that the horizontal path of the road has been established, the next step will be to generate cross-section information of existing conditions.

1. From the Sections pull-down menu, choose Input-Edit Section Alignment and supply a section alignment name of **rehab.mxs**.

2. At the centerline prompt, type C (for “CL File”) and select the **rehab.cl** file created earlier.

3. For the Alignment Settings, set the Station Interval to 25 and the Left/Right Offset values to 50.
4. Click the OK button and then click the Save button on the next dialog box showing the list of the section stations.

5. Create the actual cross-section data through the Sections → Create Sections From → Sections from Grid or Triangulation Surface command and select:
   - exist-rd.tin as the source of the surface model
   - "Prompt" as the linking method between the surface model and the output section file.
   - Note: With the prompt option, should the definition of the surface model change, you will be prompted if section data should update as well!
   - rehab.mxs as the section alignment
   - exist-rd.sct as the output section file

This completes the generation of the cross-sectional data of the existing, milled road.

Now that we've generated existing cross-section data, our next task will be to create a design template "overlay" for the road surface we wish to construct:

1. From the Roads menu, click Design Template and create a new template file named rehab.tpl.

2. Click the Grades button and indicate the following desired values for the pavement grade surface:
   - -2% Linear Slope
   - 12 feet for the Horizontal Distance
   - EP for an ID of "edge of pavement"

   Click OK to dismiss the Grade Dimensions dialog box.

3. Click the Subgrade button and indicate the following desired values for the subgrade surface:
   - Straight Up for the Intersect Surface option. This instructs the subgrade surface to intersect vertically to the grade surface above.
   - 0 for the horizontal offset distance. This instructs the subgrade surface to start directly under the centerline of the road.
   - -8 inches for the Vertical Offset. This instructs the subgrade to be 8 inches below the grade surface above and will generate the minimum 8" pavement thickness specified earlier in this lesson.
   - EP for the Distance. This instructs the subgrade width to be the same width as the EP (edge-of-pavement) width specified in the Grade Dimensions.

   Note: By using the parametric/variable ID points (e.g. the "EP" code vs the 12' Horizontal Distance, the subgrade width will vary as needed to accommodate the pavement grade width!)
• Concrete for the Material.

4. Click OK when ready to dismiss the Grade Dimensions dialog box. The proposed road template should resemble the following:

![Design Templates](image)

5. That's all that needs to be defined in the template. Click the Save button and then click Exit.

This completes the proposed definition of the new pavement overlay.

The next step is to design the proposed cross-slopes to follow the existing section grades as much as possible.

1. From the Roads menu, click Template Grade Table and create a new Template Grade Table file named `rehabtgt` and specify the `rehab.tpl` created earlier as the template file to process.
2. Highlight the GRADE surface from the Left Surface list and click the Match Slope button and identify the `exist-rd.sct` file as the Section File to Process.
3. For the Match Slope options, specify:
   - 0 for Reference 1st Offset
   - -12 for Reference 2nd Offset
   **Note:** These values sample the existing sections at the offsets specified to get the existing cross slope.
   - -2.25 for the Lowest Slope %
   - -1.56 for the Highest Slope %
   **Note:** These values restrict the design cross-slopes to be within the range specified.
   - 0.5 for the Max Slope Rate of Change Per 100. This restricts how much the design cross-slope can change between stations. For example, with the maximum set to 0.5 and a cross-slope of -2.0% at station 1+00, the cross-slope at station 2+00 must be between -2.5% and -1.5%.
4. After picking OK on this dialog, highlight the right side grade and pick the Match Slope button.
5. Use the same parameters as the left side except use Reference Offsets of 0 and 12 and then pick OK.

6. From the Template Grade Table dialog box, click Save and then click Exit.

This completes the process of generating a Template Grade Table.

The next step is to define the design profile that minimizes quantities while satisfying the design parameters.

1. From the Roads menu, click the Road Rehabilitation Profile command and specify a new file name rehab.pro.
2. For the Centerline, Design Template, Existing Surface and Template Grade Table, choose the files created in the previous steps as shown below:
3. Click the OK on the file selection dialog to get to the Process Options dialog and specify the following values:
   • Leveling for the Rehabilitation Method
   • 0 inches for the Minimum Leveling Thickness
   • 8 inches for the Overlay Thickness (the same as the Subgrade thickness defined in the Design Template).
   • EP for the Template IDs to Rehab (the same as the pavement edge ID defined in the Design Template).
   • 0.5 for Max Profile Slope Rate of Change Per 100 to restrict the rate of profile grade change.
   Note: This setting is similar to the Max Slope Rate of Change Per 100 in Match Slope for Template Grade Table except this one applies to the profile slope instead of the cross-slope.
   • Leave the rest of the settings as the defaults as shown.

4. Click the OK button to process and generate the desired rehab.pro file.

This completes the process of generating a design profile. Adjustments to the profile can be made through the Profiles → Design Road Profile → Input-Edit Road Profile command.

The road design is now ready to be computed.
1. From the Roads menu, initiate the Process Road Design command.
2. Make sure the Centerline, Profile, Design Template, Existing Surface and Template Grade Table options are each utilizing the files created earlier.
3. Click on the Design Section button to create a new file named Final-rd.sct as illustrated below:

4. Click OK when ready to continue.
5. On the Additional Road Design Parameters dialog box, accept the default values and click OK to initiate the processing of the design.

The program reports the quantities per station and totals in a report similar to that shown below:

```
Process Road Design
Template File> C:\Carlson Projects\rehab.tpl
Profile File> C:\Carlson Projects\rehab.pro
Existing Surface File> C:\Carlson Projects\exist-rd.sct
Centerline File> C:\Carlson Projects\rehab.cl
Template Grade Table File> C:\Carlson Projects\rehab.tgt
Design Section Output File> C:\Carlson Projects\Final-rd.sct

Processing 732+58.510 to 816+42.736
Total Cut : 0.001 C.F., 0.000 C.Y.
Total Fill: 12449.816 C.F., 461.104 C.Y.
Cut to Fill Ratio: 0.00
Total Left Subgrade1 - Concrete: 33533.838 C.F., 1241.994 C.Y., 100603.375 S.F., 11178.153 S.Y.
Total Right Subgrade1 - Concrete: 33533.140 C.F., 1241.968 C.Y., 100601.280 S.F., 11177.920 S.Y.
```

**Note:** Be aware of the following important values:
- The **Total Fill** is the amount of extra leveling.
- The **Subgrade Volumes** are the amount of overlay.

This completes an initial process of the design data.

Our next task will be to visually verify the design by generating cross-section plots.

1. From the Sections menu, click Draw Section File. Set the 1st section file to Exist-rd.sct and the 2nd section file to be Final-rd.sct as illustrated below:
2. On the Draw Section File dialog box, set the following values:
   • 10 for the Horizontal Scale value.
   • 5 for the Vertical Scale value.
   • Click the Scan Files to Set Defaults button to "read" the section files specified earlier and retrieve data from them.
   • Vertical Stack for the Type of Plot.
   • Enable the Label Slopes option and then click the Set button to ensure:
     (a) Label Section 1 is enabled.
     (b) Label Section 2 is enabled.

3. Click the OK button and then screen pick a point in a blank area of the drawing.

This station shows the existing surface with slopes ranging from 1.41% left to 0.57% right and the design with slopes 1.56% left and right. Since 1.56% was the minimum design cross slope, the design is steeper than existing and there is some leveling needed between the design overlay and the existing.

The profile elevation for this station was set by the right edge since this was the highest point. There is some extra
leveling fill needed on the left side. This left side slope can be steeper because our design cross-slope range is 1.56% to 2.25%.

Let's continue with additional steps to refine the design!

From the Roads menu, re-run the Road Rehabilitation Profile command again.

1. Use all the same files for the first dialog.
2. On the second dialog, enable the Adjust Template Grade Table toggle and set the Lowest and Highest Slopes and the Max Cross Slope Rate to the same design parameters used during Template Grade Table as shown below:

   ![Adjust Template Grade Table](image)

3. Click the OK button when ready.

Note: The Adjust Template Grade Table option checks the left and right grades while creating the rehabilitation profile and adjusts the slope on the side that is not controlling the profile grade.

From the Roads menu, issue the Process Road Design command again with all the same settings from the previous run.

Process Road Design

Template File> C:\Carlson Projects\rehab.tpl
Profile File> C:\Carlson Projects\rehab.pro
Existing Surface File> C:\Carlson Projects\exist-rd.sct
Centerline File> C:\Carlson Projects\rehab.cl
Template Grade Table File> C:\Carlson Projects\rehab.tgt
Design Section Output File> C:\Carlson Projects\Final-rd.sct

Processing 732+58.510 to 816+42.736
Total Cut : 21.607 C.F., 0.800 C.Y.
Total Fill: 11152.921 C.F., 413.071 C.Y.
Cut to Fill Ratio: 0.00
Total Left Subgrade1 - Concrete: 33533.761 C.F., 1241.991 C.Y., 100603.375 S.F., 11178.153 S.Y.
Total Right Subgrade1 - Concrete: 33533.107 C.F., 1241.967 C.Y., 100601.280 S.F., 11177.920 S.Y.

For this run, the Template Grade Table has been adjusted. In the report, the overlay quantities are the same and the fill quantity for the extra leveling has been reduced as expected. In this case, the Template Grade Adjustment reduced the Total Fill (extra leveling) amount from 461.104 C.Y. to 413.071 C.Y. (about a 10% reduction in needed
leveling material).

From the Sections menu, click Draw Section File command to redraw the sections data again using all the same settings. The only difference in the final section is that the left side is steeper to better match the existing surface.

This concludes this tutorial lesson on roadway rehabilitation.

**Lesson 12: Hydrology and Watershed Analysis**

This lesson will step through some of the more common Hydrology module routines, and design structures based on the analysis of the watershed. To load the Hydrology module, run Settings->Carlson Menus->Hydrology Menu. The drawing file *HydroLesson.dwg* is a nice example to show the features of the Hydrology Module. A surface *hydrolesson.tin* file is needed for these routines, and is supplied also.

Open *HydroLesson.dwg*. After opening the drawing, take a look around at the various layers, and then go to the *3D View Window* under View, to see the change of elevations in the surface.

There are two main drainage areas that we will be looking at: Drainage 1 and Drainage 2. They are labeled in the below graphic. The other drainage areas in this region will be ignored, as they do not drain to the same area we are looking at, the north central low spot.
There are routines for finding these watersheds based on grid or TIN files, but this drawing has the closed polylines already generated. We will walk through some of the steps to gather the slope and area information.

1. Slope Report. Go to View and use Freeze Layer to freeze all contours, which are on two separate layers. Then freeze the Watershed_Perim layer. We will run the following routine twice, once for each watershed. Go to the Surface pulldown menu in the Hydrology module.

From the Surface menu, choose *Slope Report*. Choose the Slope report by area option, which is the default, and you will be prompted for File or Screen. Choose File, and notice that we have the Hydrolesson.tin file, found in the
Carlson Projects folder, to analyze. Open it.

When prompted for the inclusion line, select the closed perimeter line that runs around Drainage 1. Press Enter for none when prompted for the exclusion line. The report window will appear, and the information can be saved to a file, placed on-screen, or simply reviewed here using the Carlson Standard Report Viewer. In this example, we will review the reports in the viewer. Next, analyze and report on the Drainage 2 watershed, again using Hydrolesson.tin. Shown in the following figures are the reports of the two drainage areas.
Notice that the watersheds are similar in size, and have approximately the same average slope. Thaw the layers that you froze earlier.

2 Run Off Tracking. The command *Run Off Tracking* is found under the Watershed pulldown. It will draw a 3D polyline running downhill in the path that a storm event would. It is useful to fine-tune a watershed boundary. If you pick near the boundary line, you can see which direction the water will flow. Shown is an example of the drawing with the runoff tracking lines falling within their respective watersheds.
3D Polyline Flow Values. This is a step to see what the longest flow line data is within the watersheds. It will create a nice report showing the slopes and vertical drop. The 3D polylines in the drawing were created (with runoff tracking and some editing) to represent the longest flow line. This routine reports out the values of the polylines selected. Go to the Watershed pulldown to 3D Polyline Flow Values. The report can be saved for future reference, but also be aware that when you will need to enter in this data, there is a button on the dialog to simply pick the polylines on-screen.

Drainage 1
4 Rainfall Frequency & Amount. This routine will look up rainfall depths based on what storm type and duration is being analyzed. Under Watershed, go to Rainfall Frequency & Amount. We will do the 25 year, 24 hour storm. Let’s assume the area is somewhere in South Dakota, and so we will use the value of 3.52 inches. For customizing this table to suit your needs, there is the user-defined portion in the lower left corner, if you have specific values you always use; they can be entered here for quick retrieval.

5 Sub-Watersheds by Land Use. This is another way to break up the watersheds, based on land use, or varied surface features. We will break up our watersheds into two types of land use. The steep slopes will be treed, and the top
flats will be vegetated with grasses. Go to Sub-Watersheds by Land Use under the Watershed pulldown. The routine will then ask for the watershed boundary, and the two closed polylines that make up the two different areas. Pick the lines as prompted. The two lines are drawn in layer PILLARS so that the program knows how to identify them.

6 Curve Numbers (CN) & Runoff. This is an easy step to get the runoff and volume of the storm based on the CN and acreage. We will do a weighted curve number representing two land use types. We will run this twice, once for each watershed. Go to Curve Numbers (CN) & Runoff under the Watershed pulldown.

First off, Select Areas, and pick the two closed polylines lines just created inside Drainage 1 (the PILLARS layer). They will have two different CN, based on the type of land. The area is brought in automatically, and the CN will have to be typed in, or looked up on the table. For this example, type the information in according to the charts below. After the CN numbers and the areas are in, hit the Calc Runoff button, and the runoff and volume will appear at the bottom. These can be saved in a report, or simply written down for future reference.
Drainage 1
Drainage 2

Time of Concentration (Tc). This is a quick step necessary for ultimately getting the Peak Flow. Under Watershed, go to Time of Concentration (Tc). We will use the SCS method, and the window will look as follows. The CN number should have been brought in from the last routine, but we will have to Select Flow Line from Screen. This will allow for picking the flow line from the map. This routine will also be executed twice to calculate the TC for both drainage areas.
Now, let's see what the peak flow will be in each drainage, based on the previous seven steps. Run Peak Flow->Graphical Method from the Watershed pull-down menu. The drainage area of the last watershed calculated should appear in the Area window. If not, then simply type it in. The Rainfall depth, frequency, CN, and TC also should be there. All we have to do is hit Calculate, and the peak discharge appears at the bottom.
in CFS (cubic feet per second). This routine should be run twice, once for each drainage. Notice that all of these routines have a Report button to keep a running log of all the calculated data.

Drainage 1
9. Detention Pond Sizing. Now we need to see how large the ponds need to be to detain this size of a storm event. Under Structure, go to Detention Pond Sizing > TR-55 Method.

The Peak Inflow Discharge from the last area calculated will appear, as well as the area. In this example, we will allow for a combined maximum 10 CFS to be discharged from the ponds. This means that 5 cfs from each will be our Desired Peak Outflow. Type that in. Hit Calculate, and the Runoff Volume and the Storage Volume will appear at the bottom of the window. In pond number one, we need to store 6.68 acre feet of water. In pond number two, we will need 9.07 acre feet of storage. So now we have a starting point, and we can now create the pond in 3D with.
these sizes.

Drainage 1
Drainage 2

10 Design Valley Pond. We know approximately where we want the two ponds, and have the dam polylines drawn in the drawing already. They are in the top-of-dam layer. If it is frozen then thaw it out now. We will run Design Valley Pond found under the Structure pulldown menu. For pond number one (corresponding to Drainage 1), the values to enter at each prompt are:
Pick the top of dam polyline: pick it
Select Existing Surface dialog: Open the hydrolesson.tin file
Pick a point within the pond: pick a point upstream from the top of dam polyline
Enter the outslope ratio <2.0>: 2
Enter the interior slope ratio <2.0>: 2
Range of existing elevations along dam top: 1075.88 to 1172.06
Enter the top of dam elevation: 1109
Calculate stage-storage values [Yes/No]? Y
Method to specify storage elevations [Automatic/Interval/Manual]? I
Starting elevation <1088.96>: 1088
Elevation interval <2.0>: press Enter
A Valley Pond Report is produced. Review it noting the stage at which our target storage volume is eclipsed and exit out.
Output grid file of final pond surface [Yes/No]? press Enter
Write stage-storage to file [Yes/No]? Y
This will be a *.CAP file, name it pond1.
Adjust parameters and redesign pond [Yes/No]? N
Trim existing contours inside pond perimeter [Yes/No]? N
Contour the pond [Yes/No]? N

You should now have a pond that looks like the one on the left in the following drawing. Repeat the routine for Pond 2, using a top of dam elevation of 1087, and starting at a low of 1065.
Pond Weir Spillway Design. Now let's see what the spillway will need to be for the storage calculated. We will allow 5 CFS of discharge, so what will be the elevations of the spillway? Under Structure, go to *Rectangular Weir Design*. That will bring up the following window:

![Pond Weir Spillway Design Window](image)

Pond 1
Pond 2

The C-factor we will use is about .3. We will allow up to 5 CFS discharge. This will calculate the depth of the weir (if that is what we use, we'll use a drop pipe in 1, and a channel in 2) with the equation shown at the top of the window. Our required storage volume is 6.68 acre-feet for pond one (9.07 acre-feet for pond two). Hit the Apply to Actual Pond and choose the Pond1.cap file. This should give the two elevations shown in the dialog: 1106.73 for top of pool, and 1104.50 for bottom of spillway. This will be our principle spillway. Our emergency spillway will just be assumed to be 1.5 feet higher.

12 Draw Stage-Storage Curve. Now that we have the spillway elevations and a capacity file (*.CAP) for each pond, let's draw the Stage Storage/Area Curve Graphs to get a graphic of the curves with values to follow. Under Structure, go to Stage-Storage, and then slide over to Draw Stage-Storage Curve. Below the following dialog box are the settings to be entered for Pond 1:
Click OK.

**Pick Starting Position:** *pick a spot* in the open drawing

Do the same for Pond 2, with the other elevations from the spillway and top of dam calculated above, and choose to put this on Page Number 2. Your graphs should look like the two pictured.
Drainage 2

13 Drop Pipe Spillway Design. This will give us a stage discharge file that we will add to our structure in the routine of the storm through our ponds. We will only do this in pond 1. Pond 2 will have a channel, which will create a different stage discharge file. Go to the Structure pulldown to Drop Pipe Spillway Design.

We will design one for the flow we need. Enter in the values shown in the window and hit calculate to get near the 5 CFS discharge we are looking for. Hit File to create the discharge file for pond 1.
14 Channel Design (Manning's n) Non-Erodible. This will generate the other stage discharge file for pond 2. Go to the Structure pulldown to Channel - Non-Erodible. Enter in the parameters shown, and create the second STG file, this one for pond 2. It will calculate the depth and the velocity, base on our dimensions entered.

Click Write Stage-Discharge. You will then provide a file name for the new STG file and save it. It will calculate the depth and the velocity, based on our dimensions entered. Enter a depth of 1.5 and a base elevation of 1081.95 for the bottom.

15 Draw Flow Polylines. Now we will look at creating a skeleton structure of our flow lines with these structures placed on them. We will first produce a hydrograph of the two drainages without the ponds, then add the ponds to
the flow polylines and regenerate the hydrographs. We hope to reduce the discharge to a much smaller amount, but over a longer period of time.

Under Watershed > TR-20 Routing, go to Draw Flow Polylines. This will let us pick a point, from high to low. As seen in the diagram, pick from NW to SE. Enter in the three parameters for Drainage 1.

When asked to draw another, select yes, and join it with the first at the bottom right corner, near the endpoint. This will place the text on them and allow for the next step.

16 Hydrograph Development. This routine will run the TR-20 program and generate a hydrograph file that we can draw on screen. Under Watershed > TR-20 Routing, go to Hydrograph Development and select the two Flow Polylines and the text associated with each one.

The routine will run the TR-20 and give a Standard Report Viewer report. There are now some hydrograph files
17 Draw Hydrograph. Under the Watershed pulldown, go to Draw Hydrograph and select the J1ADD.h1. This is the file of both drainages combined.

The scales to be used should be about 1,1,1,5,5,5 and we will draw the grid on the first one, and turn off grid for additional hydrographs. Choose starting time of 0, and an ending time of 80 (the next one will go that long).

18 Locate Structures. The Locate Structures command, located in the Watershed > TR-20 Routing menu, will place a symbol on our flow lines to representing the ponds and spillways. This will create a small triangle at the end of each flow line where they were picked. You will run this on each flow line individually.
Lesson 13: Stormwater Network Design

In this tutorial, we'll layout the structure and pipes for the stormwater drainage and analyze the flow for a portion of a site. We'll use the tools to automatically calculate the drainage and runoff coefficients. These automated methods require setup of a surface and runoff regions. Alternatively, these tools can be skipped in which case the drainage areas and runoff coefficients for the inlets can be entered manually into the sewer network.

Step 1 - Open Drawing

From the File menu, choose Open and select EXAMPLE3.dwg from the Carlson Work folder (e.g. C:\Carlson Projects\EXAMPLE3.dwg).

Step 2 - Make Surface Model

The drawing entities for the design surface that we will use to model drainage have already been prepared. These entities consist of design contours, elevated pad perimeter polylines, spot elevations and 3D polylines for the road centerlines and face of curbs.

To model the drainage, the program can use either triangulation or grid surfaces. For this example, triangulation is used so that the flow can follow the edges of the road. In general, triangulation is needed for surfaces with breaklines and grids are useful for surfaces defined by contours alone.

Run the Triangulate & Contour command from the Surface menu. In the dialog, go to the Contour tab and turn off Draw Contours. Then in the Triangulate tab, turn on Draw Triangulation Faces, Write Triangulation File, Use Inclusion/Exclusion Areas and Ignore Zero Elevations. Pick the Browse button and set the file name as Example3.tin. Then pick OK.
At the command line, the program will prompt for the inclusion and exclusion perimeters. Pick the perimeter polyline for the inclusion and nothing for exclusion. Next, for the select objects to triangulate, type All and press Enter.

Select the Inclusion perimeter polylines or ENTER for none.
Select objects: pick the perimeter polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Select the points and breaklines to Triangulate.
Select objects: All
Select objects: press Enter

Step 3 - Check Surface

This step is optional to verify that the surface is good by checking for bad elevation data points and that the surface follows the data points.

With the triangulation drawn as 3D Faces, run the 3D Viewer Window command in the View menu. At the command line, it will prompt to select the objects to view. Type All and press Enter.

Select all entities for the scene.
Select objects: All
Select objects: press Enter
In the 3D Viewer dialog, move the pointer near the center of the graphic and the cursor will change to an X/Y symbol which is the X/Y axis rotation mode. Click down the left mouse button and drag down to rotate the site to a good viewing angle. Then move the pointer near the edge of the graphic and the cursor will change to a Z symbol which is the Z axis rotation mode. Click down the left mouse button and drag around to rotate the pile. To fill in the triangulation faces, pick the Shade icon.

You can also choose the Color By Elevation toggle for better viewing of the elevation range.

The surface looks right in the 3D Viewer. The site has a slope from the top road circle down towards the detention ponds at the bottom. Close the 3D Viewer by choosing the Exit Door button. We don't need the 3D Faces anymore. Let's delete them by running Erase By Layer in the Edit menu. Choose the Select Layers From Screen and pick any 3D Face. Then pick the OK button.

**Step 4 - Runoff Coefficients**
This step sets up layers that are assigned Rational Method runoff coefficients and applied to closed polylines on the specified layers. The runoff coefficients are the C-Factors in the Rational Equation \( Q = C \times I \times A \).

Q is flow, I is rainfall intensity and A is area. The runoff polyline areas use region logic where a polyline inside another on the same layer is used as an exclusion. A limitation is that polylines on the same layer must not intersect each other. For polylines on different layers, there can be polylines within other polylines and for any given point; the smallest enclosing polyline is used to determine the runoff coefficient.

In this example, the site perimeter polyline is on the Regions layer, the building pads are on the Pads layer and the edge of pavement polylines are on the Roads layer. All these polylines are already closed polylines. So we're ready to assign the runoff coefficients to the layers. Run Define Watershed Layers in the Watershed menu. Begin with an empty dialog by deleting any existing layers in the table. Select the Add button.

Let's add the road layer first. Use the Select button next to the Layer field and select the layer name ROADS from the list or screen pick a road polyline. Next choose the Library button and select Streets, Asphaltic from the list. Under the Draw Settings, set the Hatch Color to Magenta. When the dialog is set as shown, pick OK.
Repeat the Add function for the Pads layer and set the runoff to Roofs and the color to Red. Again, repeat add for the Regions layer and set the runoff to Unimproved Areas and the color to Green.

From the main dialog, pick the Hatch All which gives a visual check of the runoff coefficient areas. The areas within the buildings are inside both the Region and Pads polylines and the Pads govern because they are the smaller area. Likewise the road areas are governed by the Roads layer and road interior islands are not counted for Roads because the interior Roads polyline acts as an exclusion perimeter. The rest of the area is set to the Regions layer.

With the three layers defined, click OK from the main dialog.

We don't need to keep the runoff hatches. Let's delete them by running Erase By Layer in the Edit menu. Choose the Select Layers From Screen and pick any hatch to get the RUNOFF_HATCH layer. Then pick the OK button.

**Step 5 - Watershed Analysis**

From the Watershed menu, pick Watershed Analysis and when prompted for the surface file, choose Example3.tin. The program dialog docks on the left side of the drawing.

Before processing the watersheds, set the Rainfall to 1 inch. The program uses the runoff volume calculated from the rainfall depth and drainage areas to figure when the runoff is enough for the flow to go through a low point. If the rainfall depth is set to zero, then the flow lines will stop at every low point or dimple in the surface. At this point, we have not defined our storm event to know the actual rainfall depth. If we did get the storm rainfall depth, we could enter it. For now we're just using Watershed Analysis to give a general idea of the watershed areas and runoff flow lines.

First, go to the Draw tab and turn on Fill Watershed Areas, Sink Locations and Pond Areas.

---

*Chapter 17. Tutorials*
Now pick the Draw Watersheds button. Each watershed area is drawn with a closed polyline and solid filled with different colors. Also, for each watershed the sink (lowest point) is drawn with a solid circle symbol. The areas covered by ponding are drawn as solid blue hatches. The depth and size of the pond areas is determined by the runoff volume. In many places, the pond areas are inside the detention pond structures. In a few places, the ponds are at low points in the road which indicate areas that we need to add storm sewer inlets.

To navigate around the watershed display, move the pointer into the graphic view and use the middle button of the wheel mouse, if you have one, to pan and zoom. If you don't have a wheel mouse, then use the top toolbar icons of the Watershed Analysis dialog to zoom and pan. When you are done inspecting the watersheds, pick the back arrow (shown below) next to the Draw Watershed button to erase all the watershed entities.

Next, choose the Runoff Tracking button under the Tools tab.
In the options dialog, choose Major Flow Tracking that draws flow lines only when the drainage area for the flow line is greater than the specified area. Then choose the 2D Polyline type and the Draw Flow Direction Arrow to use a flow linetype with arrows showing the flow direction.

Use the zoom and pan methods to inspect the runoff flow lines. This graphic shows the flow lines coming off the road circle at the top of the site and following the curbs. We're going to leave the runoff flow lines on the drawing to help guide the placement of inlets. Click Exit to end Watershed Analysis.
**Step 6 - Rainfall**

To setup the storm event to apply with this site, run Rainfall Library under the Sewer Network Libraries flyout in the Network menu. This command keeps a list of different storm events that you can use for different locations and requirements. Let's add a storm by picking the New button. There are six types of rainfall definitions. For this example, select the Rainfall Total (TP-40) method. In the New Rainfall dialog for the TP-40 method, fill in a name for the Rainfall ID, the rainfall amounts for the 2 and 100 year storms for 6 and 24 hours, and the average elevation for the site.

You can use the Map button to show the TP-40 rainfall maps for the different storms. And if you pick on the map display, the program will interpolate the rainfall from the maps. In this case, south central CT was picked.
Click OK on the New Rainfall dialog and then pick OK on the Rainfall Library dialog to save the changes.

Step 7 - Set Centerlines

In preparation to align the inlet symbols with the road centerlines, we need to create centerline files (.cl) for the roads. From the Centerline menu of the Civil Design or Survey modules, choose Polyline To Centerline File. In the file selection dialog, enter a name of North.cl. Then enter a starting station of 0, pick the road centerline for the loop road at the top of the site and press Enter at the end of the station list.

Beginning Station <0+00>: press Enter
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: pick the north loop road centerline
Press ENTER to continue. press Enter

Repeat Polyline To Centerline File. For the file name, enter Main.cl. Enter a starting station of 0 and pick the main road centerline.
Step 8 - Set Sewer Network Files

The storm sewer network structures and pipes are stored in a .SEW file. Once a .SEW file is set as current, the program will continue to automatically use that file. To start a new sewer network, run Set Sewer File under the Sewer Network Setup flyout of the Network menu. In the file selection dialog, choose the New tab and enter a file name of Example3.sew.

The sewer network also works with a current surface model that is used for the default rim elevations, reporting pipe cover and calculating inlet drainage areas. To set the current surface, run the Set Surface File under the Sewer Network Setup flyout of the Network menu. In the file selection dialog, choose our Example3.tin file.

Step 9 - Create Sewer Network Layout

Before starting the layout, set the object snap (osnap) to nearest (nea) to use for locating the inlets along the curb polylines. Under the Settings menu, run Aperture-Object Snap and turn on only the Nearest snap mode.

Now we're ready to layout the inlets and pipes. Let's work on the drainage for the roads of the north loop and the main road and run this flow to an outlet in the central pond.

Run Create Sewer Structure from the Network menu. The first prompt is to select from three methods to locate the inlets. Press Enter to choose the default method of screen pick. Next the inlet location is picked. Decide where to put the inlet. You can look at the runoff flow lines and place the inlet to capture these flows. When you have a place for the inlet, zoom in very close so that you can see the curb line.

**NOTE:** Be sure to pick the bottom, inside curb polyline and not the top of curb. Otherwise, the routine to find the drainage area from the surface model will not capture flow along the curb.

If you have a wheel-mouse, use the wheel to do the zoom in. Otherwise you can use the zoom toolbar or type 'z at the command prompt. After zooming in, pick a point along the curb polyline using the nearest snap to get right on the polyline. In this case, the first inlet will be on the inside curb of the north loop near the intersection as shown with the M1 symbol.
After this first inlet location is picked, the sewer network dialog is docked on the left side of the drawing. Before designing this inlet, pick the Rainfall Library button (Found under Network > Sewer Network Libraries) and select our Rain3. Next choose the Settings button and, on the Design tab, set the Direction to *Upstream To Downstream*, and uncheck the Minimize Pope Sizes in Design option. The Pipe Settings allow you to configure your design parameters. Select the Pipe tab, and change the Minimum Cover and Velocity to 2.0, Maximum Cover and Velocity to 10.0, and the Drop Across Inverts to 0.1. Now select the Display tab, and set the Display Slope In to %. Next select the Drainage tab and pick the Rainfall Library button and pick the rainfall event set in Step 6. Let's go with defaults for the rest. Pick the OK button.
Now let's work on the structure settings. Pick the Library button next to the Structure ID field. This function brings up a list of the available structures as defined in the library. There are three types of structures: box, circular and outfall. You can add your own structures to the library. For this example, use MH3. To check the dimensions for this structure, pick the Edit button. These dimensions are used for hydraulic calculations as well as drawing the structure in the profile and 3D views. Click OK from the Edit dialog and then highlight MH3 from the library list and pick OK.
Next, pick the Library button next to the Inlet field. This function shows the inlets defined in the inlet library. There are four types of inlets: slotted, curb, grate and curb/grate combo. Inlets can also be defined as located on-grade along the road or at a sag location. Like the structure library, you can add to and edit the inlet library. For this inlet, choose the Combo-Grade from the list and pick OK.

Next, pick the Select button next to the Reference CL label, select by Centerline File, and select North.cl for the centerline. This centerline can be used to align the inlet symbol. In the Symbol Rotate field, choose Parallel To CL Up.

The last change for the structure tab is to set the Depth to 5.5. After making these changes, your dialog should match the settings as shown. Pick the Apply button to save the changes and you should see the plan view symbol for the inlet change to a grate symbol.

Now move onto the Drainage tab. Here the drainage area, time of concentration, runoff coefficient and pavement parameters are set for the inlet. You can manually enter in or have the program calculate these values. With the Pick button, you can select a drainage polyline perimeter and the program will calculate the area and the weighted average runoff coefficient from the runoff layers if defined. In this example, use the Calc button to calculate all
the parameters from the surface model. The first time that Calc is called, the program takes time to calculate the triangulation flows. Then the values are filled in and the drainage area is hatched in plan view. The Time To Inlet comes from the max flow line within the drainage area and accounts for the surface slopes along the path. The Runoff Coefficient is calculated as the weighted average of the runoff sub-areas within the drainage using the runoff layers that we defined in the Define Runoff Layers command. Notice how the drainage area for M1 starts from the road high point and follows the crown of the road to the inlet. In the Pavement Parameters section, the Calc button will calculate the Pavement slopes from the surface aligned by the reference CL at the inlet location.

We're done for now with this first inlet. To add the next inlet, pick the Add button from the Structure Actions row. Pick a position along the right side curb polyline of the main road near the intersection as shown here (M2). Again, you may need to zoom in to be sure to snap onto the curb polyline.
Go to the Structure tab for M2 and change the Reference CL to Main.cl. Then go to the Drainage tab and pick Calc which fills out all the drainage values. Next select the Pipe tab. The program lists all the used and available structures for a pipe connection to the current structure. By default, a connection is made to the nearest structure as long as it's within the maximum pipe length as defined under Settings. In the dialog, set the Down Invert to 370.1. Switch back to the Structure tab and set the Invert-Out as 370.0.

To add the next inlet, pick the Add button. Then pick a position along the inside North loop curb polyline to the left of the intersection as shown here (M3).

A pipe is automatically connected to the nearest structure M1. But for this network, we don't want M3 to connect to M1. Instead, we're going to start new branch with M3. So go to the Pipe tab highlight the Upstream Connection list for M1 and pick the Remove button. On the Structure tab for M3, set the depth to 5.5. On the Drainage tab, pick Calc.

Now we're ready for the next inlet. Pick the Add button in the Structure Actions row and screen pick the position along the main road across from M2 as shown here (M4).
This inlet is on the other side of the road and the symbol is rotated the wrong way. To fix this, go to the Structure tab and change the Symbol Rotate to Parallel To CL Down and pick Apply to update the drawing. Also, change the Invert-Out to 371. Next go to the Drainage tab and pick the Calc button. Again the pipe connection defaulted to the nearest structure of M2. Instead we want the connections to go from M3 to M4 to M2. Under the Pipe tab, highlight the Upstream Connection for M2 and pick Remove. Then highlight the Available structure of M3 and pick Add. For the pipe parameters, change the Down Invert to 371.1. Then go back to the Structure tab and set the Invert-Out to 371.0.

To create the pipe from M4 to M2, pick the Edit button in the Structure Actions row. Then pick on the M2 label or symbol to edit M2. From the Pipe tab, highlight M4 from the Available list and pick Add.

Now let's add the next inlet. Pick the Add button in the Structure Actions row and pick a position further down the main road from M4 as shown here (M5).

Under the Structure tab, change the Depth to 4.5 and set Symbol Rotate to Parallel To CL Down. Under the Drainage
tab, pick Calc. Again we want to remove the default pipe connection since M5 will be the start of a new branch. Go to the Pipe tab, highlight the connection listed and pick Remove.

We have one more inlet to add. Pick the Add button and pick along the curb on the other side of the main road from M5. See M6 in the graphic here.

Under the Structure tab, set the Symbol Rotate to Parallel To CL Up to flip the symbol around. Under the Drainage tab, pick Calc. Under the pipe tab, add a connection to M2.

For the last structure, pick the Add button and pick on the 356 contour in the pond to the right of M6.

In the Structure tab, change the Structure Name to Outfall, set the Structure ID to Outfall-Wall1 and change the Depth to 4.0. In the Pipe tab, set the Down Invert to 352.0.

The initial sewer network layout is done. Pick the Close button and if prompted whether to Save Change, choose Yes.

**Step 10 - Flow Analysis**

The network flow can be analyzed in the Edit Sewer Structure and SpreadSheet Sewer Editor commands. For this example, we'll use Edit Sewer Structure. Either choose this command from the Network menu or double-click on any sewer network label. The same docked dialog from Create Sewer Structure is used. Under the Settings button, and the Drainage tab, choose Period of 50 Year and Duration of 24 Hours. Then pick OK to exit Settings.
Next, pick the Analyze button which runs the selected storm event through the system. If any of our design parameters are exceeded as specified under Settings, the program displays a report. Here's the report for our first Analysis run.

Network Design Warnings
1 Pipe Slope: 11.867 %, Max. pipe slope is 10.000 % From OUTFALL, A to M6, A
2 Pipe Velocity: 1.294 ft/s, Min. velocity is 2.000 ft/s From M2, A to M1, A
3 Pipe Velocity: 1.382 ft/s, Min. velocity is 2.000 ft/s From M4, A to M3, A
4 Pipe Velocity: 0.502 ft/s, Min. velocity is 2.000 ft/s From M6, A to M5, A
5 Pipe Velocity: 13.353 ft/s, Max. velocity is 10.000 ft/s From OUTFALL, A to M6, A

Let's take care of warning #1 for the pipe slope. Choose the Edit button on the Structure Actions row and pick the Outfall label or symbol to edit the Outfall structure. To reduce the pipe slope from M6 to Outfall while keeping the upstream pipe slopes, we will create a step-up at M6. Go to the Pipe tab and change the Up Invert to 356.0. This changes the Invert-Out at M6 while holding the Invert-In at M6.

Pick the Analyze button again. The warning report should only have the flow velocity warnings if any. Exit the report if it comes up. The flow velocity warnings can be resolved by resizing pipes and setting inverts which we will do later. Now let's review the flow results from the dialog.

From the Outfall structure, pick the Up button to move up to M6. From the Drainage tab, the flow results are displayed in the Flow Calculation section. The Flow To Inlet is calculated by the Rational Method using the Drainage Area, Time Of Concentration and Runoff Coefficient for this inlet. The Intercepted Flow, Bypassed Flow, Gutter Spread and Gutter Depth are calculated from the inlet dimensions using formulas from HEC-22. These values can be used to determine whether you have the right inlet structure to capture the flow.

Switch to the Pipe tab. The flow, area and cover are displayed for the pipe connection currently highlighted from the Upstream Connections list. The Total Flow is the accumulated flow for the current pipe. The Total Area reports the accumulated drainage areas for all the inlets coming into this pipe. The Min Cover is calculated using the surface model to the top of the pipe.
Switch to the Hydraulic Calc tab which shows a graphic of the pipe structure, ground surface, hydraulic grade line (HGL) and energy grade line (EGL), along with the HGL and EGL elevations, Flow Depth and Flow Velocity at the pipe upstream and downstream connections.

You can go to other structures to check the flow values for them or use the Report Sewer Network to review the values in a report view. For our storm event, many of the pipes can be resized. For example, the 12" pipe from M5 to M6 has only 3" flow depth. To resize the pipes, you can go to the Pipe tab and change the Pipe Size. The program can also automatically size the pipes based on the flow. To size specific pipes, go to the Pipe tab and pick on the Design toggle next to the Pipe Size field. Then run pick the Design button at the top of the dialog and the program will run a flow analysis and set the pipe size for these pipes marked for Design. To have the program size all the pipes, choose Auto Set All Pipe Sizes in the Settings dialog and then pick the Design button.

For this example, let's have the program assign all the pipe sizes. Pick the Settings button. Turn on Auto Set All Pipe Sizes and Minimize Pipe Size In Design. Then pick OK. The pipes are resized to match the flow. Pick on the Pipe and Hydraulic tabs to see the changes. Pipes that can change would change and the different pipe sizes that the program uses are defined in the Pipe Size Library.

After the pipe sizing, there are likely a few lingering flow velocity warnings. Experiment with the flow velocity by adjusting invert elevations of the affected pipe(s) in your network. Pick the Structure Action button of Edit and pick the structure whose invert elevations need to be modified.

Now run Analyze function which should now complete without any warnings. Pick the Apply button to save the results and then pick Close.

**Step 11 - Plan View Labels**

At this point, the sewer network labels are only showing the inlet name and pipe direction arrow. To change the label format, run Plan View Label Settings in the Sewer Network Setup flyout of the Network menu. In the settings dialog, under the Structure Labels tab, Add the Structure Name, Rim Elevation, Invert-In and Invert-Out labels to the Used Labels category. Under the Pipe Labels tab, turn on Label Pipe Length and Label Pipe Size. For Label
Pipe Size, set the Position as Below Pipe. Also set Pipe Direction Label to Parallel Leader and Draw Link Type to Double/Width.

![Network Label Settings dialog](image)

The sewer labels are linked to the sewer network definition so that any change to the sewer network updates the labels. If you want to explicitly update the sewer labels, run the Draw Sewer Network > Plan View command.

When sewer labels overlap other drawing entities, you can use the Move Sewer Labels command. Let's run this command and move the M4 label to the left of the inlet.

![Sewer network](image)

**Step 12 - Draw Sewer Profile**

To create a profile for the sewer network, run the Draw Sewer Network > Profile command from the Network menu. In the options dialog, set the upstream structure to M1 and the downstream to Outfall. Also turn on Draw Pipe Lateral Connections, Draw Hydraulic Grade Line and Draw Design Surface. When the setting match the dialog shown here, pick OK.
Next, select Example3.tin for the Design Surface File To Read file selection dialog. Then the Draw Sewer Profile program is started. In the Draw Sewer Profile dialog, set the Horizontal Scale and Intervals to 50 and the Vertical Scale and Intervals to 10. Then pick OK.

The next dialog prompts for the elevation range for the profile. The elevations default to fit the profile. So just pick OK.
Now there's a prompt to pick the location to draw the profile. First, zoom out to a clear space in the drawing. Then pick the lower left point for the profile. Some of the pipe labels are longer than the pipe segments, and the program prompts whether to draw the labels. Enter Y for yes.

**Pick Starting Point for Grid <0.00,0.00>: pick the lower left profile grid point**

---

**Step 13 - Draw Sewer in 3D**

Next, let's draw the sewer network in 3D. Run the Draw Sewer Network > 3D Faces command in the Network menu. This command draws the structures and pipes as 3D Faces. At the command line, press Enter to use the default layer for the 3D Faces. That's all the prompts for this command.

**Enter the layer name [SWRNET3D]: press Enter**

To view the 3D Faces, run the 3D Viewer Window command from the View menu. At the select objects prompt, type All and press Enter. Then click and drag the mouse to rotate the view to a good viewing angle as described under the Check Surface step. When done inspecting, exit the viewer by picking the Exit Door button.
Step 14 - Report Sewer Network

Finally, let's check out the reports available under the Report Sewer Network command in the Network menu.

In the Sewer Network Report dialog, you can choose which sewer runs to report and the types of reports to produce. The Report Formatter option allows you to customize which fields to include in the reports and supports outputting the reports to MS Excel and databases. There are specific reports for Inlets, Pipes, Structures and Drainage areas. Let's run the Simple Report to get the summary of our system.

Sewer Network File: C:\Carlson Projects\example3.sew
Ground Surface File: C:\Carlson Projects\Example3.tin
Design Method: Peak Discharge Calculation
Hydro Method: Rational Method
Rainfall ID: Rain3 TP-40
Return Period: 50-Year
Duration: 24-Hour
### Lesson 12: Stormwater Network Design

This lesson covers stormwater network design using Carlson Hydrology. The goal of this functionality within Carlson Hydrology is to automatically extract sub-areas needed by HydroCAD for stormwater modeling. There are 3 main considerations to prepare a dataset for extraction:

1. **Watershed (subcatchment) delineation**, with either
   - Longest flow path and average slope information for Curve Number/Lag method, or
   - Tc with sheet, shallow, and channel flow information defined for TR55 method
2. **Delineation of Hydrologic Soil Group (HSG)** with
   - HSG boundaries defined on one layer and
   - HSG labels on another layer
3. **Ground cover delineation**, with
   - Each type of different ground cover area defined as closed polylines on specific layers, corresponding with entries in the hydrocad.rcl library

---

### Lesson 14: Data Extraction for HydroCAD

This lesson covers extracting watershed data for HydroCAD stormwater modeling using Carlson Hydrology. The goal of this functionality within Carlson Hydrology is to automatically extract sub-areas needed by HydroCAD to do its stormwater modeling. There are 3 main considerations to prepare a dataset for extraction:

1. **Watershed (subcatchment) delineation**, with either
   - Longest flow path and average slope information for Curve Number/Lag method, or
   - Tc with sheet, shallow, and channel flow information defined for TR55 method
2. **Delineation of Hydrologic Soil Group (HSG)** with
   - HSG boundaries defined on one layer and
   - HSG labels on another layer
3. **Ground cover delineation**, with
   - Each type of different ground cover area defined as closed polylines on specific layers, corresponding with entries in the hydrocad.rcl library

---

---

### Chapter 17: Tutorials

---

---

---
Layer Based Process

The entire process described herein is essentially a layer based process, meaning that it is the drawing layers that everything is created on that makes the process work. So before going any further, take a look at the dialog box in which those layers are defined. On the HydroCAD menu, pick Define Watershed layers. In this dialog box, pick the Load button and load the hydrocad.rcl file that is in the Settings folder. After loading, make sure the HydroCAD radio button at the top of the screen is selected.

Any layer names in this dialog box can be changed to whatever you like, but the linework created must use the layers you decide on. A helpful trick is to highlight the layers in the list that you think you will need for the project at hand (using the Ctrl key) and then pick the Create Layers button. The layers will be created for you, thereby eliminating the need to type them all in by hand, and also avoiding typos that will cause the data extraction to fail.

The layers in the drawing must match the names in the list exactly.

Now that the layers are established, you can focus on creating the geometry in the drawing.

Watershed/Subcatchment Delineation

If there is a surface (TIN) for the project site, Carlson Hydrology can greatly aid in the process of delineat-
ing watersheds (subcatchments) and determining the longest flow path for each subcatchment. These tasks are accomplished in Hydrology, under the Watershed menu, or the HydroCAD menu, using the Watershed Analysis command.

Pick the surface for the site. Setting up the watershed panel as shown:

will generate:
Once the watersheds and max flow lines are drawn, you can make decisions on them...are there too many, too few...etc...

Tip: to combine several into one, use Draw - Shrink Wrap...use the Bound method, pick a bunch of watersheds, and a new boundary will be drawn around them.
Ultimately, you should be left with a closed polyline for each watershed, and a single 3D polyline within each watershed representing the longest flow path:
The subcatchments will need to be labeled on the correct layer, but this part of the process is essentially complete. These subcatchment delineations can be done using any process desired...looking at the contours, looking at aerial photos, whatever method is most useful and comfortable is fine. It is the end result of linework that delineates the areas that is needed...the method to get them is inconsequential.

**Soils (Hydrologic Soil Group)**

The same statement holds true for HSG delineation. What you'll need, ultimately, from whatever source(s) you start from, is a drawing with the soil groups drawn as polylines, all on one layer, and the HSG types (A, B, C, or D) labeled within the areas on another single, specific layer. The soil areas must be closed, but do not have to be individual specific closed polylines. The software will run a bpoly on each area to "close" it. The soils information can come from a SHP file from NRCS, from a ground soils survey, from digitized plans...it doesn't matter, the only thing necessary is the linework and labels.

![Soils map](image)

**Ground Covers**

Finally, ground covers. In standard use, this term applies only to the ground cover, which is independent of the underlying soil group(s). Neither layer equates to a specific CN value, which can only be determined after we analyze the intersection of these layers. The actual CN value(s) will be assigned by HydroCAD after this analysis is complete.

Once again, with whatever method you like, create closed polylines on the various ground cover layers.
Putting it all together

Now that you've draw all the watershed and site data, we can start to extract the information we need for hydrologic analysis...

On the HydroCAD menu, pick HydroNet Explorer. In the file dialog, pick the New tab and create a new .HYN file.

In the docked dialog, pick the Settings button at the top, with the tools on it. In the Settings dialog box, on the General tab, set the Surface File to your surface.
On the SubCatchment tab, set the Calculation Method to Curve Number/Lag, and clear the box to Process Curve Numbers, as they will be determined in HydroCAD. Pick OK.

You are ready for the data extraction to be performed, and the results exported to HydroCAD. Pick the Update button (the up arrow). Select all the options.

The subcatchments are listed in the HydroNet Explorer. Doubleclicking on any subcatchment name brings up a dialog with its data. Note the same subcatchments now exist in HydroCAD, ready for any further analysis and/or reporting.
The Edit button next to the Area shows all of the sub-area statistics.

Double-clicking a subcatchment in HydroCAD opens the Hydrograph and Summary report windows.
Project reports can also be generated for Nodes, Areas and Soils.
Any changes made in the drawing can instantly update the data in HydroCAD simply by picking the Update button.

Lesson 15: ESRI to Office to Field and Back

This lesson takes an ESRI geodatabase from ArcView into Carlson Survey and then to Carlson SurvCE for data collection. Next the data is taken from SurvCE into Carlson Survey and then back into ArcView.

Step 1 (ESRI Geodatabase to DWG File):

ArcGIS Desktop has a routine to output a geodatabase to a DWG file. The DWG file contains all the information in a single file. It has the graphic geometry, feature definitions and feature attribute data. The feature information is stored in a format defined by ESRI called Mapping Specification for DWG (MSD) using standard DWG entities and dictionary entries. In this tutorial, we're going to use ArcView 9.3 to create the DWG with MSD.

From the ArcToolbox, choose Conversion Tools->To CAD->Export To CAD. If you need to bring up the ArcToolbox, go to the ArcView->Window pull-down menu and pick ArcToolbox.

Next, select the features to export in the Export To CAD dialog. To select a feature, pick the down arrow on the
Input Features first row and pick the feature name from the list. After selecting the features, choose the output file format for either DWG or DXF file and the version. For example, choose DWG_2007. Finally, enter the DWG file name to create and pick OK.

Step 2 (Open Project in Carlson Survey):

Use File->Open in Carlson Survey to open the drawing created by ESRI.

Next, run GIS->GIS Database Settings. The GIS Features File defines the feature names along with their drawing properties and attribute names. Choose the GIS File format and set the file name. For the Output Data Format, choose ESRI MSD.
To verify that the GIS attribute data is in the drawing, run GIS->Input-Edit GIS Data and pick on an entity in the drawing. The attribute data is shown in a spreadsheet editor. This example shows the Roads feature data assigned to a polyline.

![GIS Smart Prompting - Entity has ESRI Map Specs for Drawings (MSD) Data](image)

**Step 3 (Export Project to SurvCE):**

From the GIS Data menu, choose Export GIS Data to SurvCE. This command takes selected data from the drawing and creates the GIS files that SurvCE uses.
For input files:
Coordinate File: Contains the point database with point#, x, y, z and description.
Field-to-Finish Table: Defines the coding for the description field that will be converted into a Feature Code List for SurvCE.
GIS Feature: Defines the feature and attribute names. Using this file is optional and applies in case that the feature definitions contain more features or attributes than the data entities.

For output files:
Feature Code File: This is the SurvCE format file for the description field coding definitions.
GIS Feature: This defines the feature and attribute names. This file is automatically named after the Feature Code File.
GIS Data: This file contains the attribute data. This file is automatically named after the Coordinate File.
Add Missing Points to Coordinate File: This option creates points in the Coordinate File for any selected point entities that aren’t already in the Coordinate File.

After specifying the files, pick OK and the program prompts for the entities from the drawing to export. You can select the entire drawing by entering “all”, or select a subset of the drawing entities. The program will read the GIS data from the selected entities to create the GIS data file (.vtt) for SurvCE.

Now that the project data is converted to SurvCE format, upload the coordinate file, feature code list, GIS feature, GIS data and drawing onto the SurvCE data collector. If you have SurvCE 2.5 or later, then you can use the DWG file format for the drawing. For earlier versions, use the DXF format. Depending on your collector and connections, you can do the upload with either Carlson Survey->Data Collectors->SurvCE, or Windows ActiveSync, or transfer on a data card. For this example, we have spatial.crd, spatial.fcl, spatial.gis, spatial.vtt and spatial.dwg to upload.

**Step 4 (Data Collection in SurvCE):**

First download the data files from the SurvCE data collector to the computer. Get the coordinate file (.crd), GIS data file (.vtt) and drawing files (.dwg or .dxf).

**Step 5 (Download Project from SurvCE):**

This step converts the SurvCE GIS data (.vtt) into the ESRI MSD format for the drawing.

First download the data files from the SurvCE data collector to the computer. Get the coordinate file (.crd), GIS data file (.vtt) and drawing files (.dwg or .dxf). Then open the drawing file and use Points->Set Coordinate
File to set the coordinate file from SurvCE as current.

From the GIS Data menu, choose Import GIS Data from SurvCE. The routine prompts for the GIS Feature Definition file (.gis) to process along with the SurvCE data to combine the feature definitions.

**Step 6 (Load Project into ESRI Geodatabase):**

Save the drawing file in Carlson and then run ArcView. Pick the Add Data button in the Standard toolbar and select the drawing.

![Image of ArcView interface](image)

**Lesson 16: Takeoff Tutorial: CAD File Takeoff From Start To Finish**

Note: Completing these tutorials will alter the drawing files (takeoffdemo1.dwg, takeoffdemo2.dwg, takeoffdemo3.dwg). To run through the tutorials a second time, copy over the original drawing files (.dwg) provided on the CD under "Tutorials". In addition, all demo .flt, .tin, .trg, .ini, .cl, .pro, .lot, .tpl, .bak, .sew, and .tch files need to be deleted from the folder under C:\Carlson Projects. If you have your own drawing files, be sure to only delete files named takeoffdemo1, or takeoffdemo2, and not a file attached to one of your own drawing.

This lesson takes a drawing file from drawing cleanup to volume calculations and surface viewing.

**Step 1 (Start Takeoff):**

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.
Step 2 (Open Drawing):

From the File menu, choose Open and select takeoffdemo1.dwg from the Carlson Projects folder.

Now we can begin to process this drawing. The main TakeOff commands are listed in processing sequence in the TakeOff pull-down menu. Many of these commands are also grouped as icons in the toolbar shown here.

Step 3 (Drawing Cleanup):
From the File menu, choose Drawing Cleanup. Typically, drawings have lots of drafting fixes that must be done before the surfaces can be modeled. This command will apply the selected cleanup functions on the drawing to help automate the cleanup. Here's a brief description of the most important of these functions:

**Remove Layers With No Entities:** Drawings often have lots of layers. This routine removes layers that have no entities in the drawing so that we don't have to deal with them.

**Join Linework With Same Endpoints:** This routine will take linework that is broken into multiple segments and join them into a single linework entity. For example, it will join together broken segments of a contour polyline into a single polyline.

**Reduce Polyline Vertices:** This routine removes extra vertices from polylines as long as the removing does not shift the polyline more than the specified Offset Cutoff. This will reduce the size and complexity of the drawing.

**Set Elevation Outside Range To Zero:** In case the drawing contains entities that are outside the range of valid elevations for the site, this routine will set them to zero elevation. The program treats zero elevations as "no elevation' and modeling will filter out these zero elevation entities.

For this site, the elevations are around 800. So let's set the Min elevation to 500 and the Max elevation to 1000. The cleanup will set any entities outside this elevation range to zero. With other TakeOff functions, we can later assign proper elevations to any of these zero elevation entities that need to be used in modeling.

Once the Drawing Cleanup options are set as shown, pick OK. When the cleanup is done, the program will show a report of the cleanup results. Pick the Exit button to exit the report viewer.
Step 4 (Layer Surface):

From the TakeOff menu, choose Define Layer Surface/Material/Subgrade. Every entity (line, polyline, point, etc) in the drawing is assigned a layer name. TakeOff uses the entity layer names to define which entities are for the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing entities are assigned their target surface by their layer name. For example, if polylines representing design contours are on the layer "Final", then "Final" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Surface dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog.

In this drawing, all the contours are for the existing ground surface. In the layer list, all the layers that start with INDEX and INTER are for these contours. So highlight these layers and then choose Move To Existing. To highlight multiple layers at a time, hold down the keyboard Ctrl key while picking with the mouse.
Next move the layer names that start with "PR" (for proposed) to the Design surface by highlighting these layers and choosing Move To Design. Also move the layer "PAD" to design.

Next pick the Save button to save our changes and then pick Exit.

There are more tools for assigning layer surfaces. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing. Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.

Some of these layers we do want to assign to existing and design. To better see the entities, zoom in on them using the View->Window command and pick two points that make a window around the entities as shown. Once zoomed in, you can see a text label of "818.70 PAD" which is for the design surface. Labels "817.00", "818.00" and "819.00" are contour labels for the existing contours. There are a few commands in the Inquiry menu to find out the layer names for these entities: List, Layer ID and Drawing Inspector. Let's run the Layer ID command and pick the "818.70 PAD" label. At the Command line, it reports this layer is "—-TX07". Next pick the "818.00" label and it reports this layer is "TEXTS". Now that we know these layer names, we can return the drawing view back by running View->Zoom->Previous and going to the Display menu and checking on Existing Drawing and Design Drawing.
Next run Define Layer/Material/Subgrade and pick the Other tab. Highlight "—TX07" and pick Move To Design. Then highlight "TEXTS" and pick Move To Existing.
Check that your Layer Surfaces match the three lists shown here. Then pick Save and Exit.

**Step 5 (Define Material/SubGrade):**

Besides assigning target surfaces by layer, layers are also used to define material names and subgrades depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must
be closed polylines. TakeOff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the area is not part of the subgrade.

First, we need to know the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is PAD. Next use Layer ID to pick the curb polyline. It reports that this layer is PR-FC-CURB.

Next we need to make sure that these polylines are closed. In this example, the outside curb polyline is open at the top. To close the polylines, run Edit->Polyline Utilities->Edit Polyline->Close Polylines. Then pick each of the pad and curb polylines and press Enter when done selecting. Here are the Command line prompts:

Select Polylines to set closed.
Select objects: 5 found, 5 total
Select objects: (Press Enter)
5 polylines already closed.
Closed 1 polylines.

Now run Define Layer Target/Material/Subgrade and pick the Design tab. Highlight layer PAD and pick the Edit button. A dialog appears for defining the pad material properties. Check on the Include In Material Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.

Next pick layer PR-FC-CURB and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.

To save the subgrade changes, pick the Save button on the Define Layer Surfaces dialog. Then choose Exit.
Now let's visually verify the subgrade areas. In the TakeOff menu, run Subgrade Areas->Hatch Subgrade Areas. There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Click OK. Then run Hatch Subgrade Areas again. This time choose Pad and set the hatch pattern to Hex with green color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. Also note that the smaller pad area is not hatched because this polyline layer is different than the bigger pad polyline. When finished viewing the subgrade areas, run TakeOff->Subgrade Areas->Erase Subgrade Hatches.

Step 6 (Elevate Drawing - 2D to 3D):

TakeOff will model the existing ground and design surfaces based on points, lines and polylines with elevation. It is essential for these drawing entities to have correct elevations in order to get correct surface models. Often the provided drawings will have the drawing entities at elevation of zero with text labels indicating the true elevation. TakeOff has many tools for assigning elevations to these entities.

To help visualize which entities need to be assigned elevation, TakeOff will color entities at zero elevation in grey. As entities get assigned elevation, they return to their original color. This elevation coloring is applied to layers that have been assigned to the existing or design surfaces.

Let's start by working on the existing surface. To isolate the existing entities, go to the Display menu and check on Existing Drawing, uncheck Design Drawing and uncheck Other Drawing. In the Inquiry menu, there are commands for checking elevations. To check the elevation of the contour polylines, run the Inquiry->List Elevation and pick a contour polyline At the command line, it reports the elevation.

Select Entity: pick pad polyline
Elevation: 816.0000
Select Entity (Enter to end): press Enter

In this example, the existing ground surface is defined by just contour polylines and these polylines already have elevation. So there are no changes needed for preparing the existing surface entities. If the contour polylines were at zero elevation, then you could use the Elevate->Assign Contour Elevation commands.
Next let's prepare the design surface. To isolate the design entities, go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Notice that all the design linework is greyed because it is at zero elevation. Run the List Elevation command and pick the main pad polyline. At the command line, it confirms that the elevation is 0.

To set the pad polyline elevation, run Elevate->Set Polyline To Elevation. Enter an elevation of 818.7 (based on the text label). At the Select objects prompt, pick the bigger pad polyline and press Enter.

New Elevation <0.0000>: 818.7
Select Lines, Arcs, Circles or Polylines for elevation change.
Select objects: (pick the pad polyline) 1 found
Select objects: press Enter
LWPOLYLINE
Number of entities changed> 1

Next let's set the elevation of the smaller pad under the main pad. First, use View->Window to zoom in around the smaller pad so that we can read the text label. The label of "17.56" is short for 817.56. In this example, the 800 was dropped from many of the elevation labels to save on label clutter. Run Set Polyline To Elevation again. This time enter an elevation of 817.56 and pick the smaller pad polyline. Then run View->Zoom->Previous to get back to the full view of the site.

Finally, we need to set the elevations for the curb polylines. First, use View->Window to zoom in around some of the curb labels below the smaller pad. Then run Elevate->2D to 3D Polyline->Text With Leader. This command will assign the elevations from the labels to the polylines by following the label leader to find the position on the polyline. For polyline vertices without elevation labels, the elevations will be interpolated from the other labels. Before processing, this routine prompts for samples of the elevation label, the leader and the polylines to convert. Then you can select all the entities in the drawing and the routine will sort the labels, leaders and polyline by the sample layers and assign the elevations.
For this example, pick one of the labels with a "TC" suffix as the elevation text sample. Then pick the leader line for the annotation leader sample. Then pick the curb polyline for the polyline to convert sample. At the Select objects prompt for processing, type "all" to select all the drawing entities and press Enter. For the elevation to add, enter 800 so that labels like "17.81" get assigned as 817.81.

Next a dialog appears for selecting which labels names to use. When Takeoff detects different text labels within the elevation labels, you need to choose which ones to process. In this case, we only want the labels with "TC". So highlight TC, pick Add and then pick OK.
Step 7 (Boundary Polyline):

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. In this example, there is a closed polyline on the PERIMETER layer. The layer target for this layer is Other. Go to the Display menu and check on Other Drawing so that the perimeter is displayed. Then run TakeOff->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the TakeOff routines.
Step 8 (Model Existing and Design Surfaces):

To calculate volumes, TakeOff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. The drawing entities have been cleaned up, assigned elevations and assigned target surfaces by layer. Making the models is now a one step process. To make the existing ground surface, run TakeOff->Make Existing Ground Surface. The program will process the entities and make the triangulation surface. Then to make the design surface, run TakeOff->Make Design Surface.

Step 9 (3D Drive Simulation):

As a visual check that the design surface modeled correctly, let's run the Tools->3D Drive Simulation command. This routine shows a 3D view of the site and allows you to drive around. This is a good way to check that the surface modeled correctly. We want to make sure that there are no elevation spikes and that the subgrade depths are modeled. To drive the site, choose a View Direction, View Position and Vehicle. Then pick the Run button and use the arrow keys to turn. Pick the Stop button to pause the moving. You can also try the Surface Shading options for different views of the surface. When done with the 3D Drive Simulation, pick the Exit button (Arrow with door image).

Step 10 (Cut/Fill Color Map):

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as another check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display->Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.
Step 11 (Calculate Volumes):

To calculate volumes, run the TakeOff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 12 (Material Quantities):

To report the quantities, run the TakeOff->Material Quantities->Standard Report routine. There is the option to only report selected entities as well as the ability to report material quantities that may extend beyond the boundary polyline.

The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities->Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.
Note: Completing these tutorials will alter the drawing files (takeoffdemo1.dwg, takeoffdemo2.dwg, takeoffdemo3.dwg). To run through the tutorials a second time, copy over the original drawing files (.dwg) provided on the CD under "Tutorials". In addition, all demo .flt, .tin, .trg, .ini, .cl, .pro, .lot, .tpl, .bak, .sew, and .tch files need to be deleted from the folder under C:\Carlson Projects. If you have your own drawing files, be sure to only delete files named takeoffdemo1, or takeoffdemo2, and not a file attached to one of your own drawing.

This lesson takes a drawing file from drawing cleanup to volume calculations and surface viewing.

**Step 1 (Start Takeoff):**

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.

**Step 2 (Open Drawing):**

From the File menu, choose Open and select takeoffdemo1.dwg from the Carlson Projects folder.

Now we can begin to process this drawing. The main TakeOff commands are listed in processing sequence in the TakeOff pull-down menu. Many of these commands are also grouped as icons in the toolbar shown here.
Step 3 (Drawing Cleanup):

From the File menu, choose Drawing Cleanup. Typically, drawings have lots of drafting fixes that must be done before the surfaces can be modeled. This command will apply the selected cleanup functions on the drawing to help automate the cleanup. Here's a brief description of the most important of these functions:

**Remove Layers With No Entities:** Drawings often have lots of layers. This routine removes layers that have no entities in the drawing so that we don't have to deal with them.

**Join Linework With Same Endpoints:** This routine will take linework that is broken into multiple segments and join them into a single linework entity. For example, it will join together broken segments of a contour polyline into a single polyline.

**Reduce Polyline Vertices:** This routine removes extra vertices from polylines as long as the removing does not shift the polyline more than the specified Offset Cutoff. This will reduce the size and complexity of the drawing.

**Set Elevation Outside Range To Zero:** In case the drawing contains entities that are outside the range of valid elevations for the site, this routine will set them to zero elevation. The program treats zero elevations as "no elevation" and modeling will filter out these zero elevation entities.

For this site, the elevations are around 800. So let's set the Min elevation to 500 and the Max elevation to 1000. The cleanup will set any entities outside this elevation range to zero. With other TakeOff functions, we can later assign proper elevations to any of these zero elevation entities that need to be used in modeling.
Once the Drawing Cleanup options are set as shown, pick OK. When the cleanup is done, the program will show a report of the cleanup results. Pick the Exit button to exit the report viewer.

Step 4 (Layer Surface):

From the TakeOff menu, choose Define Layer Surface/Material/Subgrade. Every entity (line, polyline, point, etc) in the drawing is assigned a layer name. TakeOff uses the entity layer names to define which entities are for the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing entities are assigned their target surface by their layer name. For example, if polylines representing design contours are on the layer "Final", then "Final" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Surface dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog.

In this drawing, all the contours are for the existing ground surface. In the layer list, all the layers that start with
INDEX and INTER are for these contours. So highlight these layers and then choose Move To Existing. To highlight multiple layers at a time, hold down the keyboard Ctrl key while picking with the mouse.

Next move the layer names that start with "PR" (for proposed) to the Design surface by highlighting these layers and choosing Move To Design. Also move the layer "PAD" to design.

Next pick the Save button to save our changes and then pick Exit.

There are more tools for assigning layer surfaces. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing. For example, when Design Drawing is checked, then picking this menu item will uncheck it and turn off all the layers for the design surface. Likewise, picking Design Drawing when it is unchecked will make it checked and turn on the design surface layers.

Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.
Some of these layers we do want to assign to existing and design. To better see the entities, zoom in on them using the View->Window command and pick two points that make a window around the entities as shown. Once zoomed in, you can see a text label of "818.70 PAD" which is for the design surface. Labels "817.00", "818.00" and "819.00" are contour labels for the existing contours. There are a few commands in the Inquiry menu to find out the layer names for these entities: List, Layer ID and Drawing Inspector. Let's run the Layer ID command and pick the "818.70 PAD" label. At the Command line, it reports this layer is "TX07". Next pick the "818.00" label and it reports this layer is "TEXTS". Now that we know these layer names, we can return the drawing view back by running View->Zoom->Previous and going to the Display menu and checking on Existing Drawing and Design Drawing.

Next run Define Layer/Material/Subgrade and pick the Other tab. Highlight "TX07" and pick Move To Design. Then highlight "TEXTS" and pick Move To Existing.
### Chapter 17. Tutorials

#### Define Layer Surface/Material/Subgrade

<table>
<thead>
<tr>
<th>Layer Type</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>INDEX_CONTOUR</td>
<td>NC</td>
</tr>
<tr>
<td>INDEX_DEP</td>
<td>NC</td>
</tr>
<tr>
<td>INDEX_LABEL</td>
<td>NC</td>
</tr>
<tr>
<td>INTER_CONTOUR</td>
<td>NC</td>
</tr>
<tr>
<td>INTER_DEP</td>
<td>NC</td>
</tr>
<tr>
<td>TEXTS</td>
<td>NC</td>
</tr>
</tbody>
</table>

#### Define Layer Surface/Material/Subgrade

<table>
<thead>
<tr>
<th>Layer Type</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>--- - TEC</td>
<td>NC</td>
</tr>
<tr>
<td>PAD</td>
<td>NC</td>
</tr>
<tr>
<td>FF-ELV</td>
<td>NC</td>
</tr>
<tr>
<td>FF-FC-CURE</td>
<td>NC</td>
</tr>
<tr>
<td>FRJUSTER</td>
<td>NC</td>
</tr>
<tr>
<td>FFJcS7</td>
<td>NC</td>
</tr>
</tbody>
</table>

---
Check that your Layer Surfaces match the three lists shown here. Then pick Save and Exit.

**Step 5 (Define Material/SubGrade):**

Besides assigning target surfaces by layer, layers are also used to define material names and subgrades depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must be closed polylines. TakeOff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the area is not part of the subgrade.

First, we need to know the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is PAD. Next use Layer ID to pick the curb polyline. It reports that this layer is PR-FC-CURB.

Next we need to make sure that these polylines are closed. In this example, the outside curb polyline is open at the top. To close the polylines, run Edit->Polyline Utilities->Edit Polyline->Close Polylines. Then pick each of the pad and curb polylines and press Enter when done selecting. Here are the Command line prompts:

Select Polylines to set closed.
Select objects: 5 found, 5 total
Select objects: (Press Enter)
5 polylines already closed.
Closed 1 polylines.

Now run Define Layer Target/Material/Subgrade and pick the Design tab. Highlight layer PAD and pick the Edit button. A dialog appears for defining the pad material properties. Check on the Include In Material Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.
Next pick layer PR-FC-CURB and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.

To save the subgrade changes, pick the Save button on the Define Layer Surfaces dialog. Then choose Exit.

Now let's visually verify the subgrade areas. In the TakeOff menu, run Subgrade Areas->Hatch Subgrade Areas. There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Click OK. Then run Hatch Subgrade Areas again. This time choose Pad and set the hatch pattern to Hex with green color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. Also note that the smaller pad area is not hatched because this polyline layer is different than the bigger pad polyline. When finished viewing the subgrade areas, run TakeOff->Subgrade Areas->Erase Subgrade Hatches.
Step 6 (Elevate Drawing - 2D to 3D):

TakeOff will model the existing ground and design surfaces based on points, lines and polylines with elevation. It is essential for these drawing entities to have correct elevations in order to get correct surface models. Often the provided drawings will have the drawing entities at elevation of zero with text labels indicating the true elevation. TakeOff has many tools for assigning elevations to these entities.

To help visualize which entities need to be assigned elevation, TakeOff will color entities at zero elevation in gray. As entities get assigned elevation, they return to their original color. This elevation coloring is applied to layers that have been assigned to the existing or design surfaces.

Let's start by working on the existing surface. To isolate the existing entities, go to the Display menu and check on Existing Drawing, uncheck Design Drawing and uncheck Other Drawing. In the Inquiry menu, there are commands for checking elevations. To check the elevation of the contour polylines, run the Inquiry->List Elevation and pick a contour polyline At the command line, it reports the elevation.

Select Entity: pick pad polyline
Elevation: 816.0000
Select Entity (Enter to end): press Enter

In this example, the existing ground surface is defined by just contour polylines and these polylines already have elevation. So there are no changes needed for preparing the existing surface entities. If the contour polylines were at zero elevation, then you could use the Elevate->Assign Contour Elevation commands.

Next let's prepare the design surface. To isolate the design entities, go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Notice that all the design linework is grayed because it is at zero elevation. Run the List Elevation command and pick the main pad polyline. At the command line, it confirms that the elevation is 0.

To set the pad polyline elevation, run Elevate->Set Polyline To Elevation. Enter an elevation of 818.7 (based on the text label). At the Select objects prompt, pick the bigger pad polyline and press Enter.

New Elevation <0.0000>: 818.7
Select Lines, Arcs, Circles or Polylines for elevation change.

Select objects: (pick the pad polyline) 1 found
Select objects: press Enter
LWPOLYLINE
Number of entities changed> 1

Next let's set the elevation of the smaller pad under the main pad. First, use View->Window to zoom in around the smaller pad so that we can read the text label. The label of "17.56" is short for 817.56. In this example, the 800 was dropped from many of the elevation labels to save on label clutter. Run Set Polyline To Elevation again. This time enter an elevation of 817.56 and pick the smaller pad polyline. Then run View->Zoom->Previous to get back to the full view of the site.

Finally, we need to set the elevations for the curb polylines. First, use View->Window to zoom in around some of the curb labels below the smaller pad. Then run Elevate->2D to 3D Polyline->Text With Leader. This command will assign the elevations from the labels to the polylines by following the label leader to find the position on the polyline. For polyline vertices without elevation labels, the elevations will be interpolated from the other labels. Before processing, this routine prompts for samples of the elevation label, the leader and the polylines to convert. Then you can select all the entities in the drawing and the routine will sort the labels, leaders and polyline by the sample layers and assign the elevations.
For this example, pick one of the labels with a "TC" suffix as the elevation text sample. Then pick the leader line for the annotation leader sample. Then pick the curb polyline for the polyline to convert sample. At the Select objects prompt for processing, type "all" to select all the drawing entities and press Enter. For the elevation to add, enter 800 so that labels like "17.81" get assigned as 817.81.

Next a dialog appears for selecting which labels names to use. When Takeoff detects different text labels within the elevation labels, you need to choose which ones to process. In this case, we only want the labels with "TC". So highlight TC, pick Add and then pick OK.
Select sample of elevation text: pick label
Select sample of an annotation leader: pick leader line
Select sample of a polyline to convert: pick curb polyline
Select polylines to convert, leaders and elevation labels to process.
Select objects: all
Select objects: press Enter
Joining adjacent polylines...
Reading the selection set ...
Enter elevation to add to label values <0.00>: 800
Pre-processing entity #420 of 420
Processing leader #141
Remaking polyline #4
All the curb polylines now have elevations.
Now run View->Zoom->Previous to return to the full site view. The design polylines should now have colors because the elevations are assigned.

**Step 7 (Boundary Polyline):**

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. In this example, there is a closed polyline on the PERIMETER layer. The layer target for this layer is Other. Go to the Display menu and check on Other Drawing so that the perimeter is displayed. Then run TakeOff->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the TakeOff routines.
Step 8 (Model Existing and Design Surfaces):

To calculate volumes, TakeOff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. The drawing entities have been cleaned up, assigned elevations and assigned target surfaces by layer. Making the models is now a one step process. To make the existing ground surface, run TakeOff->Make Existing Ground Surface. The program will process the entities and make the triangulation surface. Then to make the design surface, run TakeOff->Make Design Surface.

Step 9 (3D Drive Simulation):

As a visual check that the design surface modeled correctly, let's run the Tools->3D Drive Simulation command. This routine shows a 3D view of the site and allows you to drive around. This is a good way to check that the surface modeled correctly. We want to make sure that there are no elevation spikes and that the subgrade depths are modeled. To drive the site, choose a View Direction, View Position and Vehicle. Then pick the Run button and use the arrow keys to turn. Pick the Stop button to pause the moving. You can also try the Surface Shading options for different views of the surface. When done with the 3D Drive Simulation, pick the Exit button (Arrow with door image).

Step 10 (Cut/Fill Color Map):

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as another check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display->Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.
Step 11 (Calculate Volumes):

To calculate volumes, run the TakeOff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 12 (Material Quantities):

To report the quantities, run the TakeOff->Material Quantities->Standard Report routine. There is the option to only report selected entities as well as the ability to report material quantities that may extend beyond the boundary polyline.

The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities->Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.
Lesson 17: Takeoff Tutorial: Drillhole and Strata

This lesson creates and processes drillhole data.

Step 1 (Run Lesson 1 Example):

This drillhole lesson builds on the resulting drawing called takeoffdemo1.dwg from the tutorial lesson 13 (Takeoff Basics). Before continuing with this tutorial, run through and complete this lesson 1 tutorial.

When lesson 13 is done, let's set the display to show only the design entities. In the Display menu, turn off Existing Drawing and Other Drawing and turn on Design Drawing. Then run, View->Zoom->Extents. Now we're ready to add drillholes.

Step 2 (Drillhole/Strata Settings):

From the Drillhole menu, choose Drillhole/Strata Settings. This command sets the drillhole symbol and the default strata names. For this tutorial, we are interested in rock quantities and we need to define two strata: Dirt (material above the rock) and Rock.
Pick the Add button which brings up another dialog that defines a strata. Enter a strata name of "DIRT" and a density of 125 which will be used to calculate tons in the volume report. You can also have a strata specific cut swell factor. The strata can be modeled either by the elevations from the drillholes or by the depth from the existing ground. In this case, we will model by strata elevation. There are also 3 options of modeling methods. Linear Least Squares extrapolates trends and allows for a strata model to create new highs and lows, that don't appear in the original drillhole data. Inverse Distance will not carry trends and the calculated strata model will never be higher or lower than the original drillhole data. Inverse Distance uses a weighted average of the drillhole data. In general, closer drillholes are weighted more than drillhole farther away. Inverse Distance - Power 3 will weigh drillholes less that are further away. Inverse Distance - Power 2 will weigh them more. When the dialog is filled out as shown, pick OK.

Next, pick the Add button again. This time, fill out the dialog with a strata name of "ROCK" and density of 150. Then pick OK.

The Strata Definitions in the main dialog need to be in top to bottom order. To change the order, highlight a strata name and use the Move Up or Move Down buttons. In this case, we want Dirt then Rock. Click OK now from the main dialog.
Step 3 (Input Drillhole Data):

There are two different methods for entering drillhole data into Takeoff: Drillhole Import and Place Drillhole. Drillhole Import reads the drillhole data from a text file. This command supports customizing the sequence of drillhole data fields to match the format of the text file. Place Drillhole creates the drillholes at picked positions in the drawing and enters the data in a dialog. For this tutorial, we will use Place Drillhole.

Run the Drillhole->Place Drillhole command. At the command line, there is a prompt to pick the drillhole location. If you know the coordinates for the drillhole, you can type in the easting,northing instead of picking on the screen. In this case, let's pick a point above the upper right of the main building.

Pick Drillhole Location: *pick a point*
Then there is a dialog for entering the drillhole data. The surface elevation is automatically filled in using the existing ground surface model. The Drillhole Name and Description are optional. The list of strata defaults to the strata defined in Drillhole/Strata Settings. Each strata defaults to a thickness of zero. To set the strata thickness, highlight the strata and pick the Edit button.

For this case, highlight Dirt and pick Edit. This brings up the Edit Strata dialog. The strata position can be defined by thickness, elevation or depth. Setting any one of these fields will update the other fields. For our dirt strata, fill in a thickness of 2 and then pick OK.

![Edit Strata dialog](image)

Next, pick Rock from the strata list and pick Edit. For this example, we only know the depth to the top of rock depth and not the total rock thickness. We will treat all cut below the top of rock as rock strata. So we will set the rock thickness deep enough to be lower than the deepest cut on site. In this case, we will use a rock thickness of 15. So in the Edit Strata dialog for rock, enter a thickness of 15 and then pick OK.

After editing the rock strata, we are returned to the main Edit Drillhole dialog. Pick the Save button.

![Place Drillhole dialog](image)

Now let’s locate two more drillholes using a different method. Return Drillhole/Strata Settings dialog and change Place Drillhole Prompts to Thickness. Also, check on Default Thickness and set it to 15 feet, Press OK.
Now run Place Drillhole again and for the second drillhole, pick a position in the lower parking lot. The command line will prompt you to enter a dirt thickness, type in 1.5 and your drillhole is created. For the third drillhole, pick a position left of the main building. Enter a dirt thickness of 3.0, save, and enter to end the command.

Step 4 (Make Strata Surfaces):

Now that the drillholes are in the drawing, to make the strata triangulation surfaces, run the Drillhole->Make Strata Surfaces command. There are no prompts for this routine. The strata surfaces are modeled from the drillholes and saved with the project. The file names for the strata surfaces use the drawing name plus "-ch#" where the # is the strata sequence number. For this example, the file names will be "takeoffdemo1-ch1" for bottom of dirt and "takeoffdemo1-ch2" for bottom of rock.

Now that the strata surfaces are created, there are several Takeoff routines that will use these surfaces such as:
- Calculate Total Volumes
- Calculate Volumes Inside Perimeter
- Cut/Fill Labels
- Surface Inspector
- Quick Profile
- Trench Network Quantities

Step 5 (Draw Strata Cut Color Map):

From the Drillhole menu, pick Draw Strata Cut Color Map. This command compares the design surface with the strata surface to make a cut color map of the cut depths for the strata. This command is one way to verify that the strata surfaces are modeled correctly.

There is a dialog to select which strata map to draw. Choose Rock and pick OK. Then there is an option to draw a cut depth legend. Pick a position for the legend in the upper left of the site and use the defaults for size and
Step 6 (Calculate Total Volumes):

Run the Takeoff->Calculate Total Volumes command. When strata surfaces are defined, the volume routine will breakout the cut volume into the different strata. The resulting dirt and rock quantities are shown in the report.
This lesson creates and processes drillhole data.

**Step 1 (Run Lesson 1 Example):**

This drillhole lesson builds on the resulting drawing called takeoffdemo1.dwg from the tutorial lesson 13 (Takeoff Basics). Before continuing with this tutorial, run through and complete this lesson 1 tutorial.

When lesson 13 is done, let's set the display to show only the design entities. In the Display menu, turn off Existing Drawing and Other Drawing and turn on Design Drawing. Then run, View->Zoom->Extents. Now we're ready to add drillholes.

**Step 2 (Drillhole/Strata Settings):**

From the Drillhole menu, choose Drillhole/Strata Settings. This command sets the drillhole symbol and the default strata names. For this tutorial, we are interested in rock quantities and we need to define two strata: Dirt (material above the rock) and Rock.
Pick the Add button which brings up another dialog that defines a strata. Enter a strata name of "DIRT" and a density of 125 which will be used to calculate tons in the volume report. You can also have a strata specific cut swell factor. The strata can be modeled either by the elevations from the drillholes or by the depth from the existing ground. In this case, we will model by strata elevation. There are also 3 options of modeling methods. Linear Least Squares extrapolates trends and allows for a strata model to create new highs and lows, that don't appear in the original drillhole data. Inverse Distance will not carry trends and the calculated strata model will never be higher or lower than the original drillhole data. Inverse Distance uses a weighted average of the drillhole data. In general, closer drillholes are weighted more than drillhole farther away. Inverse Distance - Power 3 will weigh drillholes less that are further away. Inverse Distance - Power 2 will weigh them more. When the dialog is filled out as shown, pick OK.

Next, pick the Add button again. This time, fill out the dialog with a strata name of "ROCK" and density of 150. Then pick OK.

The Strata Definitions in the main dialog need to be in top to bottom order. To change the order, highlight a strata name and use the Move Up or Move Down buttons. In this case, we want Dirt then Rock. Click OK now from the main dialog.
Step 3 (Input Drillhole Data):

There are two different methods for entering drillhole data into Takeoff: Drillhole Import and Place Drillhole. Drillhole Import reads the drillhole data from a text file. This command supports customizing the sequence of drillhole data fields to match the format of the text file. Place Drillhole creates the drillholes at picked positions in the drawing and enters the data in a dialog. For this tutorial, we will use Place Drillhole.

Run the Drillhole->Place Drillhole command. At the command line, there is a prompt to pick the drillhole location. If you know the coordinates for the drillhole, you can type in the easting,northing instead of picking on the screen. In this case, let's pick a point above the upper right of the main building.

Pick Drillhole Location: pick a point

Then there is a dialog for entering the drillhole data. The surface elevation is automatically filled in using the existing ground surface model. The Drillhole Name and Description are optional. The list of strata defaults to the strata defined in Drillhole/Strata Settings. Each strata defaults to a thickness of zero. To set the strata thickness, highlight the strata and pick the Edit button.

For this case, highlight Dirt and pick Edit. This brings up the Edit Strata dialog. The strata position can be defined by thickness, elevation or depth. Setting any one of these fields will update the other fields. For our dirt strata, fill in a thickness of 2 and then pick OK.
Next, pick Rock from the strata list and pick Edit. For this example, we only know the depth to the top of rock depth and not the total rock thickness. We will treat all cut below the top of rock as rock strata. So we will set the rock thickness deep enough to be lower than the deepest cut on site. In this case, we will use a rock thickness of 15. So in the Edit Strata dialog for rock, enter a thickness of 15 and then pick OK.

After editing the rock strata, we are returned to the main Edit Drillhole dialog. Pick the Save button.

Now let's locate two more drillholes using a different method. Return Drillhole/Strata Settings dialog and change Place Drillhole Prompts to Thickness. Also, check on Default Thickness and set it to 15 feet. Press OK.

Now run Place Drillhole again and for the second drillhole, pick a position in the lower parking lot. The command line will prompt you to enter a dirt thickness, type in 1.5 and your drillhole is created. For the third drillhole, pick a position left of the main building. Enter a dirt thickness of 3.0, save, and enter to end the command.

**Step 4 (Make Strata Surfaces):**

Now that the drillholes are in the drawing, to make the strata triangulation surfaces, run the Drillhole->Make Strata Surfaces command. There are no prompts for this routine. The strata surfaces are modeled from the drillholes.
and saved with the project. The file names for the strata surfaces use the drawing name plus "-ch#" where the # is the strata sequence number. For this example, the file names will be "takeoffdemo1-ch1" for bottom of dirt and "takeoffdemo1-ch2" for bottom of rock.

Now that the strata surfaces are created, there are several Takeoff routines that will use these surfaces such as:
- Calculate Total Volumes
- Calculate Volumes Inside Perimeter
- Cut/Fill Labels
- Surface Inspector
- Quick Profile
- Trench Network Quantities

**Step 5 (Draw Strata Cut Color Map):**

From the Drillhole menu, pick Draw Strata Cut Color Map. This command compares the design surface with the strata surface to make a cut color map of the cut depths for the strata. This command is one way to verify that the strata surfaces are modeled correctly.

There is a dialog to select which strata map to draw. Choose Rock and pick OK. Then there is an option to draw a cut depth legend. Pick a position for the legend in the upper left of the site and use the defaults for size and zone summary.

![Select Strata To Process](image)

**Step 6 (Calculate Total Volumes):**

Run the Takeoff->Calculate Total Volumes command. When strata surfaces are defined, the volume routine will
breakout the cut volume into the different strata. The resulting dirt and rock quantities are shown in the report.

Lesson 18: Takeoff Tutorial: Trench Network Quantities

This lesson takes a drawing file through the steps of trench network quantities.

Step 1 (Start Takeoff):

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog and if so, click Exit.

Step 2 (Open Drawing):

From the File menu, choose Open and select Takeoffdemo2.dwg from the Carlson Projects folder.
Step 3 (Make Existing and Design Surfaces):

In order to calculate trench quantities and profiles in this drawing, we need surfaces for the existing ground and design.

First we need to define the layers of the surfaces. Run TakeOff->Define Surface Target/Material/Subgrade. Then from the tab labeled "Other", highlight "EX_CTR" from the layer list, pick "Existing" from the Move To list and pick the Move To button. Next, highlight "RD RF CONT", choose "Design" from the Move To list and pick the Move To button. Now choose the Save and then Exit buttons. This assigned layer "EX_CTR" to the existing ground surface and "RD RF CONT" to the design surface.
Next, let’s set the site perimeter. Run TakeOff->Boundary Polyline->Set Boundary Polyline. At the command line, there is a prompt:
Select boundary polyline:
Pick anywhere along the six sided perimeter polyline in the drawing.

Now, to make the existing ground surface, run TakeOff->Make Existing Ground Surface. Then to make the design surface, run TakeOff->Make Design Surface.

**Step 4 (Input Trench Network Data):**

The trench network data consists of linked structures where each structure has a name, location (x,y), invert-in, invert-out and rim elevation. Each structure link has a pipe size. There are two ways of entering the trench data. When the drawing contains polylines for the trench lines and labels with the trench data, then you can use Input Trench From Polyline. Otherwise, there is the Create Trench Network Structure command which let’s you pick the structure locations and enter the data in a dialog.

Method 1 (Input Trench Line):
In this example, there is trench data already drawn in the drawing. Zoom in around the upper right area of trench line by running View->Zoom->Window and picking two corner points around this area.

Then run Trench->Input Trench Line and an options dialog appears. In this case, our Input Method is from a Polyline. We also want Trench Type as Sewer because there are manhole rim elevations. Also Prompt For Invert-In Elevations is active since this example has a manhole with multiple connections with different invert-ins. And Connected Network is used so that the trench data can be used by the rest of the trench routines. The Individual Profile option will only create a profile (.pro) file. Prompt For Pipe Wall Thickness allows you to enter in the pipe thickness that will be added to the interior pipe size for accurate volume calculations. Fill out the dialog as shown and click OK.

![Input Trench Dialog](image)

The rest of the prompting for this command is on the command line as the program walks through the trench line. For each point in the trench polyline, the program zooms the drawing to that point. The trench data can be picked from labels in the drawing. If the drawing doesn't have labels for the data, then you can enter the values.
Pick a polyline that represents a trench reach: *Pick the trench polyline*

Starting Station of trench reach <0.0>: 0.0

For station 0.00 ...

Enter/<Select text of Manhole ID>: *Pick the DCB 368 label.* (If you had a drawing without a manhole ID label, then type E for Enter and enter the ID)

ID: DCB 368

Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=174 label.* (Since this is the upstream starting manhole, there really isn't a separate invert-in. So we are using the invert-out).

Invert-In: 174.000

Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=174 label.*

Invert-Out: 174.000

Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.75 label.*

Rim: 178.750

For station 201.44 ...

Enter/<Select text of Manhole ID>: *Pick the DCB 367 label.*

ID: DCB 367

Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=172.85 label.*

Invert-In: 172.850

Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=172.35 label.*

Invert-Out: 172.350

Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.5 label.*

Rim: 178.500

Undo/Enter/<Select text of pipe size>: *Pick the 15" HDPE label.*

Pipe Size: 15.0

For station 327.09 ...

Enter/<Select text of Manhole ID>: *Pick the CB 347 label.*

ID: CB 347

Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=170.540 (CB 367) label.* (This is the invert-in for the connection to the CB 367 structure that this trench line connects to.)

Invert-In: 170.540

Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=166.1 label.*

Invert-Out: 166.100

Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=176.5 label.*

Rim: 176.500

Undo/Enter/<Select text of pipe size>: *Pick the 15" HDPE label.*

Pipe Size: 15.0

Another Polyline [<Yes>/No]? N for no.
That completes this trench run and Takeoff draws its own trench polyline and labels.

Method 2 (Create Trench Network Structure):
The drawing contains another trench polyline and we could use Input Trench Data From Polyline again. Instead for practice, let's use the Create Trench Network Structure method. First we need to zoom to the new trench location. Run View–>Zoom–>Extents and then View–>Zoom–>Window and pick two points for a window around the lower right trench point (CB 349). Then run Trench–>Create Trench Network Structure. At the command line, there is a prompt for how to locate the structure position. Choose Pick. Locate by pick point, point number or station-offset [<Pick>/Number/CL]? Pick

Next, there is a prompt to pick the position. To get the exact end point of the trench polyline, use the end point snap. The end point snap can be turned on by a number of different ways including the Settings–>Object Snap command. In this case, type "end" and then space or enter. This puts the program in end point snap mode. Now move the pointer along the trench polyline until the end point snap icon is at the manhole location and then pick. Pick structure location: end of (pick point)

Now a dialog appears for entering the structure data. Fill in the Structure Name as CB 349, the Rim Elevation as 187.8, the Invert-Out as 178.3, the Structure Width as 4.00 and then pick OK.
All the structures are now created. The last step is to link this new structure to the network. We need to zoom to the next trench location. Run View->Zoom->Extents and then View->Zoom->Window and pick two points for a window around the left trench point (CB 347). Now run Trench->Edit Trench Network Structure and pick either the symbol for CB 347 or the label. Then a dialog appears with the data for CB 347. From the Available list, highlight CB 349 and pick Add. This creates a link from CB 347 to CB 349 and the link data is shown at the bottom of the dialog. Enter the Invert-In as 171 and the Pipe Size as 24. Then pick OK.

![Trench Structure Data dialog](image)

**Step 5 (Input-Edit Trench Template):**

The Trench Template defines the size of the trench for quantities. Run Trench->Input-Edit Trench Template. You are first prompted for a trench template file name. The Trench Template data is stored in a file that has a .tch extension. Choose the New tab, enter a file name like trench1 and then pick Open.

Next, there is a dialog for entering the trench dimensions. The Bottom Offset is the distance from the bottom of the pipe to the bottom of the trench. The Trench Width is the base width of the trench. The Vertical Side Height is the height from the bottom that the side walls are vertical until switching to the cut slope. If the surface is not reached by the vertical side height, then the cut slope is used for the rest of the distance to the surface. Edit Trench Benches allows you to set up to four benches in your trench. Display Sewer Structure allows you to see your pipe or manhole as part of the trench. Note: This is for display purposes only, calculations will be drawn from the pipe size you set in the Trench Network Structure commands. Add Pipe Diameter To Trench Width will increase the size of your trench by the diameter of your different pipe sizes. The Cut Slope can be entered in slope percent, ratio or degree format. The Backfill materials are optional. They can be defined from the top or bottom of the trench. Up to three materials can be entered from the bottom.

Fill out the dialog as shown and pick Save and Exit.
Step 6 (Trench Network Quantities):

To calculate and report the trench quantities, run Trench->Trench Network Quantities. A dialog sets the report options. Check on Calculate All Trenches to get the quantities for the whole network. To get the trench cut volume, check Use Trench Template For Quantities and pick Set Trench Template and pick trench1.tch. Also turn on Report Backfill Volumes to use our backfill material settings from the trench template. Finally, fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Once the dialog is filled out as shown, pick Setup Depth Zones.
Fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Finally, click OK and OK in the main dialog and the report is shown.

The report includes:
- The structure names at the start of each trench run included in the report.
- The trench template dimensions.
- The cut volume.
- The backfill volumes.
- The number of manholes and length of trench within each depth zone.

The depth zones in the plain view with Zone Map Color Legend.
Step 8 (Draw Trench Network Profile):

To draw a profile of the trench line, run the Trench->Draw Trench Network (Profile) command. There is a dialog to select the starting structure for which trench line to process. Choose DCB 368. Also, there are options whether to draw the existing ground, design surface and strata surfaces if available. You can also choose the profile direction to go upstream or downstream. The Save To Profile File will create a profile (.pro) file for the trench. Fill out the dialog as shown and pick OK.

![Draw Trench Network](image.png)

Next the Draw Profile dialog appears. Set the Horizontal Scale and intervals to 50 and the Vertical Scale and intervals to 25. This will make for two to one vertical exaggeration for the profile. Click OK.
Next, there are prompts at the command line for the profile grid elevations and profile location. Bottom Elevation of Profile Grid <150.0>: Press Enter
Top Elevation of Profile Grid <200.0>: Press Enter
Pick Starting Point for Grid <409458.0, 207303.0>: Pick a point in a blank area off to the side of the drawing.

There is a final command line prompt for whether to use the manhole elevations. Enter Yes which will use the rim elevations defined in our trench network.

Use manhole elevations from profile [Yes/No]? Y for yes.

The profile shows the existing ground at the top, then the design surface and then the trench.

This lesson takes a drawing file through the steps of trench network quantities.

**Step 1 (Start Takeoff):**

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a
"Startup Wizard" dialog and if so, click Exit.

Step 2 (Open Drawing):

From the File menu, choose Open and select Takeoffdemo2.dwg from the Carlson Projects folder.

Step 3 (Make Existing and Design Surfaces):

In order to calculate trench quantities and profiles in this drawing, we need surfaces for the existing ground and design.

First we need to define the layers of the surfaces. Run TakeOff->Define Surface Target/Material/Subgrade. Then from the tab labeled "Other", highlight "EX_CTR" from the layer list, pick "Existing" from the Move To list and pick the Move To button. Next, highlight "RD RF CONT", choose "Design" from the Move To list and pick the Move To button. Now choose the Save and then Exit buttons. This assigned layer "EX_CTR" to the existing ground surface and "RD RF CONT" to the design surface.
Next, let's set the site perimeter. Run TakeOff->Boundary Polyline->Set Boundary Polyline. At the command line, there is a prompt:
Select boundary polyline:
Pick anywhere along the six sided perimeter polyline in the drawing.

Now, to make the existing ground surface, run TakeOff->Make Existing Ground Surface. Then to make the design surface, run TakeOff->Make Design Surface.

**Step 4 (Input Trench Network Data):**

The trench network data consists of linked structures where each structure has a name, location (x,y), invert-in, invert-out and rim elevation. Each structure link has a pipe size. There are two ways of entering the trench data. When the drawing contains polylines for the trench lines and labels with the trench data, then you can use Input Trench From Polyline. Otherwise, there is the Create Trench Network Structure command which let's you pick the structure locations and enter the data in a dialog.

Method 1 (Input Trench Line):
In this example, there is trench data already drawn in the drawing. Zoom in around the upper right area of trench line by running View->Zoom->Window and picking two corner points around this area.

Then run Trench->Input Trench Line and an options dialog appears. In this case, our Input Method is from a Polyline. We also want Trench Type as Sewer because there are manhole rim elevations. Also Prompt For Invert-In Elevations is active since this example has a manhole with multiple connections with different invert-ins. And Connected Network is used so that the trench data can be used by the rest of the trench routines. The Individual Profile option will only create a profile (.pro) file. Prompt For Pipe Wall Thickness allows you to enter in the pipe thickness that will be added to the interior pipe size for accurate volume calculations. Fill out the dialog as shown and click OK.
The rest of the prompting for this command is on the command line as the program walks through the trench line. For each point in the trench polyline, the program zooms the drawing to that point. The trench data can be picked from labels in the drawing. If the drawing doesn’t have labels for the data, then you can enter the values.

Pick a polyline that represents a trench reach: *Pick the trench polyline*
Starting Station of trench reach <0.0>: 0.0
For station 0.00 ...
Enter/<Select text of Manhole ID>: *Pick the DCB 368 label.* (If you had a drawing without a manhole ID label, then type E for Enter and enter the ID)
ID: DCB 368
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I Out=174 label.* (Since this is the upstream starting manhole, there really isn’t a separate invert-in. So we are using the invert-out).
Invert-In: 174.000
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=174 label.*
Invert-Out: 174.000
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.75 label.*
Rim: 178.750
For station 201.44 ...
Enter/<Select text of Manhole ID>: *Pick the DCB 367 label.*
ID: DCB 367
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=172.85 label.*
Invert-In: 172.850
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=172.35 label.*
Invert-Out: 172.350
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=178.5 label.*
Rim: 178.500
Undo/Enter/<Select text of pipe size>: *Pick the 15” HDPE label.*
Pipe Size: 15.0
For station 327.09 ...
Enter/<Select text of Manhole ID>: *Pick the CB 347 label.*
ID: CB 347
Undo/Enter/<Select text of Invert-in elevation>: *Pick the I In=170.540 (CB 367) label.* (This is the invert-in for the connection to the CB 367 structure that this trench line connects to.)
Invert-In: 170.540
Undo/Enter/<Select text of Invert-out elevation>: *Pick the I Out=166.1 label.*
Invert-Out: 166.100
Undo/Enter/<Select text of manhole rim elevation>: *Pick the R=176.5 label.*
Rim: 176.500
Undo/Enter/<Select text of pipe size>: *Pick the 15” HDPE label.*
Pipe Size: 15.0
Another Polyline [<Yes>/No]? N for no.

That completes this trench run and Takeoff draws its own trench polyline and labels.

Method 2 (Create Trench Network Structure):
The drawing contains another trench polyline and we could use Input Trench Data From Polyline again. Instead for practice, let's use the Create Trench Network Structure method. First we need to zoom to the new trench location. Run View->Zoom->Extents and then View->Zoom->Window and pick two points for a window around the lower right trench point (CB 349). Then run Trench->Create Trench Network Structure. At the command line, there is a prompt for how to locate the structure position. Choose Pick.
Locate by pick point, point number or station-offset [<Pick>/Number/CL]? *Pick*

![Pick Point](image)

Next, there is a prompt to pick the position. To get the exact end point of the trench polyline, use the end point snap. The end point snap can be turned on by a number of different ways including the Settings->Object Snap command. In this case, type "end" and then space or enter. This puts the program in end point snap mode. Now move the pointer along the trench polyline until the end point snap icon is at the manhole location and then pick.
Pick structure location: *end of (pick point)*
Now a dialog appears for entering the structure data. Fill in the Structure Name as CB 349, the Rim Elevation as 187.8, the Invert-Out as 178.3, the Structure Width as 4.00 and then pick OK.

All the structures are now created. The last step is to link this new structure to the network. We need to zoom to the next trench location. Run View→Zoom→Extents and then View→Zoom→Window and pick two points for a window around the left trench point (CB 347). Now run Trench→Edit Trench Network Structure and pick either the symbol for CB 347 or the label. Then a dialog appears with the data for CB 347. From the Available list, highlight CB 349 and pick Add. This creates a link from CB 347 to CB 349 and the link data is shown at the bottom of the dialog. Enter the Invert-In as 171 and the Pipe Size as 24. Then pick OK.
Step 5 (Input-Edit Trench Template):

The Trench Template defines the size of the trench for quantities. Run Trench->Input-Edit Trench Template. You are first prompted for a trench template file name. The Trench Template data is stored in a file that has a .tch extension. Choose the New tab, enter a file name like trench1 and then pick Open.

Next, there is a dialog for entering the trench dimensions. The Bottom Offset is the distance from the bottom of the pipe to the bottom of the trench. The Trench Width is the base width of the trench. The Vertical Side Height is the height from the bottom that the side walls are vertical until switching to the cut slope. If the surface is not reached by the vertical side height, then the cut slope is used for the rest of the distance to the surface. Edit Trench Benches allows you to set up to four benches in your trench. Display Sewer Structure allows you to see your pipe or manhole as part of the trench. Note: This is for display purposes only, calculations will be drawn from the pipe size you set in the Trench Network Structure commands. Add Pipe Diameter To Trench Width will increase the size of your trench by the diameter of your different pipe sizes. The Cut Slope can be entered in slope percent, ratio or degree format. The Backfill materials are optional. They can be defined from the top or bottom of the trench. Up to three materials can be entered from the bottom.

Fill out the dialog as shown and pick Save and Exit.
Step 6 (Trench Network Quantities):

To calculate and report the trench quantities, run Trench->Trench Network Quantities. A dialog sets the report options. Check on Calculate All Trenches to get the quantities for the whole network. To get the trench cut volume, check Use Trench Template For Quantities and pick Set Trench Template and pick trench1.tch. Also turn on Report Backfill Volumes to use our backfill material settings from the trench template. Finally, fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Once the dialog is filled out as shown, pick Setup Depth Zones.
Fill out the depth zones in the intervals that you are interested in. In this case, use 15, 20 and 25. The depth zones will be colored in the plain view. Finally, click OK and OK in the main dialog and the report is shown.

The report includes:
- The structure names at the start of each trench run included in the report.
- The trench template dimensions.
- The cut volume.
- The backfill volumes.
- The number of manholes and length of trench within each depth zone.
Step 7 (Draw Trench Network Profile):

To draw a profile of the trench line, run the Trench->Draw Trench Network (Profile) command. There is a dialog to select the starting structure for which trench line to process. Choose DCB 368. Also, there are options whether to draw the existing ground, design surface and strata surfaces if available. You can also choose the profile direction to go upstream or downstream. The Save To Profile File will create a profile (.pro) file for the trench. Fill out the dialog as shown and pick OK.

Next the Draw Profile dialog appears. Set the Horizontal Scale and intervals to 50 and the Vertical Scale and intervals to 25. This will make for two to one vertical exaggeration for the profile. Click OK.
Next, there is a dialog to prompt for the profile grid elevations. Pick OK to accept the defaults. Then there is a command line prompt for the profile location.

Pick Starting Point for Grid <409458.0, 207303.0>: *Pick a point in a blank area off to the side of the drawing.*

There is a final command line prompt for whether to use the manhole elevations. Enter Yes which will use the rim elevations defined in our trench network.

Use manhole elevations from profile [Yes/No]? Y for yes.

The profile shows the existing ground at the top, then the design surface and then the trench.

Lesson 19: Takeoff Tutorial: Digitizing

This lesson transfers a paper plan into Carlson Takeoff.

Step 1 (Setup):

To digitize in Carlson Takeoff, you need to install the Wintab digitizer driver. See Digitizer Setup in the manual if
you have not installed or have problems with the Wintab driver. If Wintab is installed, then make sure your drawing board is on and take the paper plan provided with the manual and place it on your drawing board.  

Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog similar to the one shown below, if so click New.

![Startup Wizard](image)

If a Startup Wizard did not appear, then under File menu, select New to start a new drawing. You will be prompted for a template to use. Templates determine the default settings for your drawing. For this tutorial, select site.dwt or carlson.dwt and click Open.

![Select template](image)
Next, the New Drawing Wizard appears for setting the drawing name. Click on the Set button at the top dialog. In the file selection dialog, enter the file name of "digitize" and pick the Save button. Then Exit the New Drawing Wizard. From here, a Data Files dialog appears where no changes are needed. Pick the Exit button.

![New Drawing Wizard](image)

**Step 2 (Tablet Calibration):**

To start things off, you need to set the coordinate system for the paper plan by running the Calibrate command under Digitize menu and sub-menu Tablet. Calibration is required to let the program know the orientation and scale of the paper plan.

![Tablet Calibration](image)

There are two different Calibration Methods: Known Reference Points and Drawing Scale with New Reference Points. Known Reference Points allows you to enter in the coordinates of two marked points on the paper plan. This method applies when you know the coordinates of at least two points on the paper plans. Drawing Scale with New Reference Points allows you to setup a coordinate system for the plans by entering the plan scale and picking any two points from the paper plan with the digitizer puck.

In this case, we will use Drawing Scale with New Reference Points. First, enter in the Drawing Scale listed on the paper plan. On this drawing, the scale is 1:40, so enter in 40. Use the default coordinates for Point 1 and click OK. Now Carlson Takeoff will prompt you for your First and Second Reference points. Generally, you want to pick to points on the drawing that you can find and use again in case you need to recalibrate. Also, the further away the points are from each other, the more accurate the coordinate system will be. With the digitizer puck, pick...
on the icon in the lower left and upper right of the drawing for the two Reference Points. The first point is assigned the coordinates of 1000,1000 from the dialog and the second point is assigned coordinates to match with the plan scale. From now on, all of your points will be in relation to these two points.

Step 3 (Digitizing Existing Contours):

We will now digitize the existing contours. Under the Digitize menu, click on Existing and then go to Contour Polyline, and this dialog will appear. Enter in a Layer Name of XCONT and select OK. Note: your Elevation Interval should match the intervals marked on your paper drawing. In this drawing, the interval is the same as the default of 1.00.

The rest of the prompting occurs at the command line and starts with the contour elevation. Find the lowest elevation for the existing contours labeled in bottom right corner of the paper plan zoomed in on below. In this example, the lowest elevation is 624 feet. The elevation can be entered either with the digitizer puck keys or with the computer keyboard. The layout of the digitizer keys is set in Digitizing Settings->Puck Layout. Press Enter after you have entered in 624. You want to enter in the lowest contour so that as Carlson Takeoff adds the Elevation Interval, it is from lowest to highest.
Next, you will see the following prompt:

**Sketch[0]/Exit[A]/Pick the first point:**

There are two different ways to digitize: in Pick Mode or Sketch Mode. You can switch between them at anytime. In this tutorial we will run through how to do both. For now, type in [0] and press enter to get into Sketch Mode. In Sketch Mode, you will be prompted to Pick and drag. The point you pick is the starting point of a contour. Drag is asking you to follow that contour with the digitizer puck on the paper plan. Click a second time when you have traced the entire contour and have reached the end of the contour. You will then be prompted as follows:

**Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end):**

Type in [B] for Undo if you made a mistake and need to sketch part of the contour again. [A] will close the contour, and [0] will switch you into Pick Mode. We still have more existing contours to digitize, so press Enter to end and answer yes to the Digitize Another Contour prompt. Takeoff will prompt you to verify the elevation. Remember, we set the Elevation Interval to one, so the default elevation for your next contour line is 625, press Enter. Now, pick the endpoint of the next contour and trace it in the same manner as the previous contour.

Now let's try Pick Mode. Say yes to digitize another contour and check to see if the default elevation corresponds with the contour your about to digitize. If not, simply type in the correct number in the command line. Next, pick [0] to get into Pick Mode. In Pick Mode, you do not have to trace the contour. Rather, pick with the digitizer puck to create points that will make up the contour. Note: Less picks are needed on fairly straight segments. Conversely, more picks will give you a more accurate contour. Press Enter when you have reach the end of the contour. Repeat this until you have digitized all of the existing contours you want to have in Takeoff (see below).
Step 4 (Digitizing the Design):

Now we will digitize the building and curb linework of the Design Surface using the Digitize 2D Polyline and 3D Polyline commands. Besides drawing the linework positions, we will also assign layer names to the linework that we will use later to identify the types of linework. In this example, there are no design contours, only the design building and curb linework and spot elevations.

Let's begin by digitizing the main building. Under Digitize, check on Design and go to 2D Polyline. 2D Polyline is used to digitize linework entities with one elevation. Toggle off the check box Use current drawing layer and name the layer NEW BUILD. Toggle on the Prompt For Polyline Elevation option. Then click OK.

At the command line, enter in the building elevation of 634.41 found labeled in the middle of the building and press Enter. Then pick the points that define the building outline. Start in the upper left corner and pick at every corner around the building. When you have picked around the entire building, type in [A] for close to finish digitizing the building.
Enter polyline elevation <0.00>: 634.41

First point: pick a building point

Close[A]/Undo[B]/Osnap[.]./Pick next point (Enter to end): pick ========= This lesson transfers a paper plan into Carlson Takeoff.

**Step 1 (Setup):**

To digitize in Carlson Takeoff, you need to install the Wintab digitizer driver. See Digitizer Setup in the manual if you have not installed or have problems with the Wintab driver. If Wintab is installed, then make sure your drawing board is on and take the paper plan provided with the manual and place it on your drawing board. Click the icon for Takeoff on your desktop or from the toolbar to launch the program. You may be presented with a "Startup Wizard" dialog similar to the one shown below, if so click New.

If a Startup Wizard did not appear, then under File menu, select New to start a new drawing. You will be prompted for a template to use. Templates determine the default settings for your drawing. For this tutorial, select site.dwt and click Open.
Next, the New Drawing Wizard appears for setting the drawing name. Click on the Set button at the top dialog. In the file selection dialog, enter the file name of "digitize" and pick the Save button. Then Exit the New Drawing Wizard. From here, a Data Files dialog appears where no changes are needed. Pick the Exit button.

Step 2 (Tablet Calibration):

To start things off, you need to set the coordinate system for the paper plan by running the Calibrate command under Digitize menu and sub-menu Tablet. Calibration is required to let the program know the orientation and scale of the paper plan.
There are two different Calibration Methods: Known Reference Points and Drawing Scale with New Reference Points. Known Reference Points allows you to enter in the coordinates of two marked points on the paper plan. This method applies when you know the coordinates of at least two points on the paper plans. Drawing Scale with New Reference Points allows you to setup a coordinate system for the plans by entering the plan scale and picking any two points from the paper plan with the digitizer puck.

In this case, we will use Drawing Scale with New Reference Points. First, enter in the Drawing Scale listed on the paper plan. On this drawing, the scale is 1:40, so enter in 40. Use the default coordinates for Point 1 and click OK. Now Carlson Takeoff will prompt you for your First and Second Reference points. Generally, you want to pick to points on the drawing that you can find and use again in case you need to recalibrate. Also, the further away the points are from each other, the more accurate the coordinate system will be. With the digitizer puck, pick on the icon in the lower left and upper right of the drawing for the two Reference Points. The first point is assigned the coordinates of 1000,1000 from the dialog and the second point is assigned coordinates to match with the plan scale. From now on, all of your points will be in relation to these two points.
Step 3 (Digitizing Existing Contours):

We will now digitize the existing contours. Under the Digitize menu, click on Existing and then go to Contour Polyline, and this dialog will appear. Enter in a Layer Name of XCONT and select OK. Note: your Elevation Interval should match the intervals marked on your paper drawing. In this drawing, the interval is the same as the default of 1.00.

The rest of the prompting occurs at the command line and starts with the contour elevation. Find the lowest elevation for the existing contours labeled in bottom right corner of the paper plan zoomed in on below. In this example, the lowest elevation is 624 feet. The elevation can be entered either with the digitizer puck keys or with the computer keyboard. The layout of the digitizer keys is set in Digitizing Settings->Puck Layout. Press Enter after you have entered in 624. You want to enter in the lowest contour so that as Carlson Takeoff adds the Elevation Interval, it is from lowest to highest.
Next, you will see the following prompt:

**Sketch[0]/Exit[A]/Pick the first point:**

There are two different ways to digitize: in Pick Mode or Sketch Mode. You can switch between them at anytime. In this tutorial we will run through how to do both. For now, type in [0] and press enter to get into Sketch Mode. In Sketch Mode, you will be prompted to Pick and drag. The point you pick is the starting point of a contour. Drag is asking you to follow that contour with the digitizer puck on the paper plan. Click a second time when you have traced the entire contour and have reached the end of the contour. You will then be prompted as follows:

**Pick[0]/Close[A]/Undo[B]/Pick and drag (Enter to end):**

Type in [B] for Undo if you made a mistake and need to sketch part of the contour again. [A] will close the contour, and [0] will switch you into Pick Mode. We still have more existing contours to digitize, so press Enter to end and answer yes to the Digitize Another Contour prompt. Takeoff will prompt you to verify the elevation. Remember, we set the Elevation Interval to one, so the default elevation for your next contour line is 625, press Enter. Now, pick the endpoint of the next contour and trace it in the same manner as the previous contour.

Now let's try Pick Mode. Say yes to digitize another contour and check to see if the default elevation corresponds with the contour your about to digitize. If not, simply type in the correct number in the command line. Next, pick [0] to get into Pick Mode. In Pick Mode, you do not have to trace the contour. Rather, pick with the digitizer puck to create points that will make up the contour. Note: Less picks are needed on fairly straight segments. Conversely, more picks will give you a more accurate contour. Press Enter when you have reach the end of the contour. Repeat this until you have digitized all of the existing contours you want to have in Takeoff (see below).
Step 4 (Digitizing the Design):

Now we will digitize the building and curb linework of the Design Surface using the Digitize 2D Polyline and 3D Polyline commands. Besides drawing the linework positions, we will also assign layer names to the linework that we will use later to identify the types of linework. In this example, there are no design contours, only the design building and curb linework and spot elevations.

Let's begin by digitizing the main building. Under Digitize, check on Design and go to 2D Polyline. 2D Polyline is used to digitize linework entities with one elevation. Toggle off the check box Use current drawing layer and name the layer NEW_BUILD. Toggle on the Prompt For Polyline Elevation option. Then click OK.

At the command line, enter in the building elevation of 634.41 found labeled in the middle of the building and press Enter. Then pick the points that define the building outline. Start in the upper left corner and pick at every corner around the building. When you have picked around the entire building, type in [A] for close to finish digitizing the building.
Enter polyline elevation <0.00>: 634.41
First point: pick a building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): pick >>>>>>>> 1.8 the next building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): pick the <<<<<< Lesson_13_Digitizing.html last building point
Close[A]/Undo[B]/Osnap[.]/Pick next point (Enter to end): A to close

Digitize Another NEW_BUILD Polyline [Yes(A)/<No(B)>]? B for No

Notice that the parking lot linework consists of different elevation levels. To digitize entities with more than one elevation, go to Digitize and select 3D Polyline from the pull-down menu. Make sure that the Prompt For Polyline Elevation option is on, the Use current drawing layer toggle is off and name the layer NEW EDGE ASPH.

Let's start by digitizing the parking lot starting from the zoomed in section below. The edge of asphalt is the inside line. The parking lot elevation labels have been shortened on the paper plan. For example, they read 35.37 and 35.12, when the actual elevations are 635.37 and 635.12. Enter in 600 as the Elevation Adder, then click OK.
Click on the point with the digitizer puck where the 35.37 elevation label points to in the upper left corner of the parking lot. When prompted for Elevation enter in 35.37. Pick below the first point where the linework starts to curve. We do not have an elevation for this point, but we can interpolate the elevation from the two points around it using the interpolate option. Type in I for interpolate or hit the A button on the Puck. Next pick the middle point of the curve and again use Interpolate for the elevation. Next pick the end of the curve at the 35.12 label and enter in the elevation 35.12. Continue digitizing for the rest of the edge of asphalt linework. Digitize each point where there is an elevation label and each point where the curb line changes direction.

The first prompts should resemble these:

**First point:** pick first point (at 35.37 label)

Interpolate[A]/screen Pick/<Elevation[B]><0.00>: 35.37

Z: 635.37

Close[A]/Undo[B]/Osnap[.]Pick next point (Enter to end): pick next point (start of curve)


Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation<Interpolate>: pick next point (middle of curve)

This point elevation will be interpolated upon completion.

Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation<Interpolate>: pick next point (end of curve, at 35.12 label)

This point elevation will be interpolated upon completion.

Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnap[.]/Next point or elevation<Interpolate>: 35.12 (Enter)
To check the elevations of the interpolated points go to List under the Inquiry menu and click on the poly-line you just created and press Enter. A text window will appear showing you the layer name, coordinates, and elevation of each point. To return to the main graphic screen, press F2.

Use the 3D Polyline command to digitize the rest of the parking lot as seen below.

![Diagram of parking lot](image)

**Step 5 (Area):**

Now that we have digitized the Design Surface, let's check the Area of certain sections. Select Area under the Digitize Menu and match the below dialog.

![Digitize Areas dialog](image)

To approximate the area of the main building, pick the points of the building outline.

**Command:** `dig_area`

**Pick starting point:** Pick points as close to the building design linework as you can
Digitize Another Area [<Yes(A)>/No(B)]? B

When finished with the building points, press Enter to end. Then answer no for no more areas. Takeoff will then display an Area report similar to the one shown below.

Step 6 (Spot Elevations):

In our paper drawing, we have two spot elevations labeled 32.57 and 32.41 shown in the bottom left below.
To digitize these elevations, we can use the Spot Elevation command under the Digitize menu. Fill out the Spot Elevation dialog as shown and pick OK.

In the paper plan, find and click on the spot elevations with the puck. When prompted, enter in their corresponding elevations of 632.57 and 632.41.

**Step 7 (Boundary Polyline):**

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. Under the digitize menu, check on Other and then select Perimeter. Type in PERIMETER as the layer name. Now digitize around the bold, outside line shown below.
Say No to the prompt: **Digitize Another PERIMETER Polyline [Yes(A)/No(B)]?**

Now run Tools->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the Takeoff routines.

**Step 8 (Layer Targets):**

From the Tools menu, choose Define Layer Target/Material/Subgrade. Every entity (line, polyline, point, etc) in the drawing is assigned a layer name. Takeoff uses the entity layer names to define which entities are for the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing entities are assigned their target surface by their layer name. For example, if polylines representing design contours are on the layer "NEW", then "NEW" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Targets dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog. We have already defined the layers for their correct targets. We did this by check on Existing, Design, or Other in the pull-down menu.

Check that your Layer Targets resemble the three lists shown here. If a layer is out of place, highlight it, and hit the "Move To" button after selecting the correct target to send it to. After reviewing, pick Save and Exit.
### Chapter 17. Tutorials

#### Define Layer Targets

<table>
<thead>
<tr>
<th>Layer</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXISTING</td>
<td>NO</td>
</tr>
<tr>
<td>XCOUNT</td>
<td>NO</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Layer</th>
<th>Report Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINAL</td>
<td>NO</td>
</tr>
<tr>
<td>NEW EDGE</td>
<td>NO</td>
</tr>
<tr>
<td>ASPH</td>
<td>NO</td>
</tr>
<tr>
<td>NEW_BUILD</td>
<td>NO</td>
</tr>
</tbody>
</table>

- **Existing**
- **Design**
- **Other**
Now that the layer targets are defined, there are several commands that can be applied. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing, or by right-clicking with your mouse.

Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.

Step 9 (Define Material/SubGrade):

Besides assigning target surfaces by layer, layers are also used to define material names and subgrade depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must be closed polylines. Takeoff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the
area is not part of the subgrade.

First, let's confirm the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is NEW BUILD. Next use Layer ID to pick the curb polyline. It reports that this layer is NEW EDGE ASPH.

Now run Define Layer Target/Material/Subgrade and pick the Design tab. Highlight layer NEW BUILD and pick the Edit button. A dialog appears for defining the pad material properties. Check on the Include In Material Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.

Next pick layer NEW EDGE ASPH and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.
To save the subgrade changes, pick the Save button on the Define Layer Targets dialog. Then choose Exit.

Now let's visually verify the subgrade areas. In the TakeOff menu, run Subgrade Areas->Hatch Subgrade Areas. There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Change the color to green and click OK. Then run Hatch Subgrade Areas again. This time choose Pad and set the hatch pattern to Hex with blue color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. When finished viewing the subgrade areas, run TakeOff->Subgrade Areas->Erase Subgrade Hatches.
Step 10 (Model Existing and Design Surfaces):

To calculate volumes, Takeoff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. To make the existing ground surface, run Tools->Make Existing Ground Surface. The program will process the entities and make the triangulation surface. Then to make the design surface, run Tools->Make Design Surface.

Step 11 (Cut/Fill Color Map):

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as a check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display->Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. You can also draw a legend for the Color Map by going to Draw, Cut/Fill Map Legend. Pick a point on your drawing to locate the legend and press Enter. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.

Step 12 (Calculate Volumes):

To calculate volumes, run the TakeOff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 13 (Material Quantities):

To report the material quantities, run the TakeOff->Material Quantities->Standard Report routine. The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities->Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.
Close[A]/Undo[B]/Osnaps/./Pick next point (Enter to end): A to close

Digitize Another NEW_BUILD Polyline [Yes(A)/<No(B)>]? B for No

Notice that the parking lot linework consists of different elevation levels. To digitize entities with more than one elevation, go to Digitize and select 3D Polyline from the pull-down menu. Make sure that the Prompt For Polyline Elevation option is on, the Use current drawing layer toggle is off and name the layer NEW EDGE ASPH.

Let's start by digitizing the parking lot starting from the zoomed in section below. The edge of asphalt is the inside line. The parking lot elevation labels have been shortened on the paper plan. For example, they read 35.37 and 35.12, when the actual elevations are 635.37 and 635.12. Enter in 600 as the Elevation Adder, then click OK.
Click on the point with the digitizer puck where the 35.37 elevation label points to in the upper left corner of the parking lot. When prompted for Elevation enter in 35.37. Pick below the first point where the linework starts to curve. We do not have an elevation for this point, but we can interpolate the elevation from the two points around it using the interpolate option. Type in I for interpolate or hit the A button on the Puck. Next pick the middle point of the curve and again use Interpolate for the elevation. Next pick the end of the curve at the 35.12 label and enter in the elevation 35.12. Continue digitizing for the rest of the edge of asphalt linework. Digitize each point where there is an elevation label and each point where the curb line changes direction.

The first prompts should resemble these:

**First point:** pick first point (at 35.37 label)
**Interpolate[A]/screen Pick/<Elevation[B]> <0.00>: 35.37

**Z: 635.37**

**Close[A]/Undo[B]/Osnaps./Pick next point (Enter to end):** pick next point (start of curve)
**Slope/Ratio/Interpolate[A]/Degree/screen Pick/<Elevation[B]> <635.37>:** Press the [A] button on the Puck for Interpolate

**Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnaps./Next point or elevation<Interpolate>:** pick next point (middle of curve)
This point elevation will be interpolated upon completion.

**Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnaps./Next point or elevation<Interpolate>:** pick next point (end of curve, at 35.12 label)
This point elevation will be interpolated upon completion.

**Slope/Ratio/Elevation[B]/Degree/screen Pick/Osnaps./Next point or elevation<Interpolate>: 35.12 (Enter)**

To check the elevations of the interpolated points go to List under the Inquiry menu and click on the polyline you just created and press Enter. A text window will appear showing you the layer name, coordinates, and elevation of each point. To return to the main graphic screen, press F2.
Use the 3D Polyline command to digitize the rest of the parking lot as seen below.

**Step 5 (Area):**

Now that we have digitized the Design Surface, let's check the Area of certain sections. Select Area under the Digitize Menu and match the below dialog.

To approximate the area of the main building, pick the points of the building outline.

**Command:** *dig_area*  
**Pick starting point:** *Pick points as close to the building design linework as you can*  
**Undo [B]**/Pick next point (Enter to end):  
**Undo [B]**/Pick next point (Enter to end):  
**Undo [B]**/Pick next point (Enter to end):  
**Undo [B]**/Pick next point (Enter to end):  
**Undo [B]**/Pick next point (Enter to end):
When finished with the building points, press Enter to end. Then answer no for no more areas. Takeoff will then display an Area report similar to the one shown below.

![Area Report](image)

**Step 6 (Spot Elevations):**

In our paper drawing, we have two spot elevations labeled 32.57 and 32.41 shown in the bottom left below.

![Spot Elevations](image)

To digitize these elevations, we can use the Spot Elevation command under the Digitize menu. Fill out the Spot
Elevation dialog as shown and pick OK.

In the paper plan, find and click on the spot elevations with the puck. When prompted, enter in their corresponding elevations of 632.57 and 632.41.

**Step 7 (Boundary Polyline):**

The limits of the site are defined by a closed polyline. This polyline is used as the boundary for the models and the volumes. Under the digitize menu, check on Other and then select Perimeter. Type in PERIMETER as the layer name. Now digitize around the bold, outside line shown below.

Say No to the prompt: **Digitize Another PERIMETER Polyline [Yes(A)/<No(B)>]??**

Now run Tools->Boundary Polyline->Set Boundary Polyline and pick the perimeter polyline. This selected polyline is now set as the boundary polyline for the rest of the Takeoff routines.
Step 8 (Layer Targets):

From the Tools menu, choose Define Layer Target/Material/Subgrade. Every entity (line, polyline, point, etc) in the drawing is assigned a layer name. Takeoff uses the entity layer names to define which entities are for the existing ground surface, the design surface or no surface. These surfaces are referred to as the "Target" surfaces. The drawing entities are assigned their target surface by their layer name. For example, if polylines representing design contours are on the layer "NEW", then "NEW" will be set as a layer for the design surface. For layers of entities that are for neither existing nor design surfaces (such as text labels for street names), the layer target is set to Other.

The Define Layer Targets dialog has three lists of layers: Existing, Design and Other. To switch between lists, pick the tabs at the top of the dialog. We have already defined the layers for their correct targets. We did this by check on Existing, Design, or Other in the pull-down menu.

Check that your Layer Targets resemble the three lists shown here. If a layer is out of place, highlight it, and hit the "Move To" button after selecting the correct target to send it to. After reviewing, pick Save and Exit.
Now that the layer targets are defined, there are several commands that can be applied. In the Display menu, you can turn on/off whether to display layer targets by using Existing Drawing, Design Drawing and Other Drawing, or by right-clicking with your mouse. For example, when Design Drawing is checked, then picking this menu item will uncheck it and turn off all the layers for the design surface. Likewise, picking Design Drawing when it is unchecked will make it checked and turn on the design surface layers.

Practice turning on/off the Existing, Design and Other Drawing in the Display menu. When only Existing Drawing is on, you should see just the contours. When only Design Drawing is on, you should see just the design polylines...
and leader labels. When only Other Drawing is on, you should see the entities that are assigned to neither existing nor design.

---

**Step 9 (Define Material/SubGrade):**

Besides assigning target surfaces by layer, layers are also used to define material names and subgrade depths. By assigning material names and depths to layers, the volume, area, length and count for entities on these layers can be reported. Also the depth is used to vertically adjust the design surface. The polylines used for subgrade depth must be closed polylines. Takeoff supports nested subgrade polylines for exclusion areas such as islands by counting how many subgrade polylines surround an area. If the number is odd, then the area is inside the subgrade. Otherwise the area is not part of the subgrade.

First, let's confirm the layer names for our subgrades. Go to the Display menu and check on Design Drawing, uncheck Existing Drawing and uncheck Other Drawing. Then run Inquiry->Layer ID and pick the large pad polyline. It reports that this layer is NEW BUILD. Next use Layer ID to pick the curb polyline. It reports that this layer is NEW EDGE ASPH.

Now run Define Layer Target/Material/Subgrade and pick the Design tab. Highlight layer NEW BUILD and pick the Edit button. A dialog appears for defining the pad material properties. Check on the Include In Material Report option, enter the Material Name as "Pad", set the first subgrade name to "Pad", and set the Depth as 1. Once the dialog is filled out as shown, pick OK.
Next pick layer NEW EDGE ASPH and choose Edit. In the Edit Materials dialog, check on Include In Material Report, set the Material Name to "Pavement", set the first subgrade name to "Pavement", and set the Depth to 1.5. Then pick OK.

To save the subgrade changes, pick the Save button on the Define Layer Targets dialog. Then choose Exit.

Now let's visually verify the subgrade areas. In the TakeOff menu, run Subgrade Areas->Hatch Subgrade Areas. There is a dialog to select which subgrade to hatch. Choose the Pavement. Then there is a dialog for the hatch pattern and color. Change the color to green and click OK. Then run Hatch Subgrade Areas again. This time choose
Pad and set the hatch pattern to Hex with blue color. The resulting hatch areas show where the subgrade is applied. Notice how the islands are not hatched because they are curb polylines that are already inside another curb polyline. When finished viewing the subgrade areas, run TakeOff- Subgrade Areas Erase Subgrade Hatches.

**Step 10 (Model Existing and Design Surfaces):**

To calculate volumes, Takeoff needs two surfaces: existing ground and design. These surfaces are modeled by triangulation. With the preparation of the previous steps, we're now ready to make the models. To make the existing ground surface, run Tools- Make Existing Ground Surface. The program will process the entities and make the triangulation surface. Then to make the design surface, run Tools- Make Design Surface.

**Step 11 (Cut/Fill Color Map):**

Cut/Fill color maps can be used for a visual output of the site cut/fill areas and also serves as a check that the models are correct. In the Display menu, choose Cut/Fill Color Map. Cut areas are drawn in different shades of red for different depths of cut while fill areas are drawn in blue. To change the resolution of the color blocks, run Display- Display Options and change the Cut/Fill Color Map Subdivisions. This parameter is the number of rows and columns of color blocks to create. You can also draw a legend for the Color Map by going to Draw, Cut/Fill Map Legend. Pick a point on your drawing to locate the legend and press Enter. To turn off the color map, go to the Display menu and pick Cut/Fill Color Map to uncheck it.
Step 12 (Calculate Volumes):

To calculate volumes, run the TakeOff->Calculate Total Volumes command. There is an options dialog for setting the cut swell factor and fill shrink factor. These values get multiplied into the cut/fill volumes. Set these factors as desired and click OK. Then the routine calculates the volumes and display the report which includes the cut/fill volumes and areas. The report can be printed or saved to a file. Pick the Exit button to exit the report viewer.
Step 13 (Material Quantities):

To report the material quantities, run the TakeOff->Material Quantities->Standard Report routine. The report includes the count, length, area and volume for each type of material that was assigned for reporting in the Define Layer Target/Material/Subgrade command. The Material Quantities->Custom Report routine can be used to reporting these values with control of the report format and the option to export to Excel.

Lesson 20: Takeoff Tutorial: PDF Section Import

This lesson imports cross sections from a PDF into Carlson .SCT format. PDF files can contain different types of data. Some PDF's contain linework vectors and others have images. For linework data, the program brings the linework into the drawing. For images, the program can either insert the image into the drawing or run a raster-to-vector conversion process to create linework in the drawing. In this first example, the PDF file contains linework.

To begin, run the Import PDF File command in the Tools->Import/Export menu. This command requires you have the program ghostscript installed. For instructions on installing ghostscript, see the Import PDF File portion of this
The program starts by selecting the PDF file to import. Then there is an options dialog. Turn on the Use Colors, Join Nearest and Reduce Vertices options as shown. Then pick Insert Linework.

Then the program reads the PDF file to determine the number of pages and let's you select the range to import.

Next, the program prompts for a point to place the linework from the PDF into the drawing. Pick a point in a blank area of the drawing. Then enter the rotation angle. In this case, enter 90 for the rotation. Finally, enter the scale. At this point, we don't know the scale. So enter 1 and we will scale later.

Pick point to insert PDF: pick a point
Specify rotation angle <0.0>: 90
Specify scale <1.0>: press Enter

The next step is to scale the drawing to match the scale of the section sheets. From the Edit menu, choose Scale Wizard. Use the Screen Pick option to set the scale factor. This routine prompts to pick two points from the drawing and then enter the correct distance between these two points. Pick two points with a known distance such as two points on the section grid. It's best to pick two points that are far apart to reduce errors with screen picking precision. For this example, pick at offset 0 and at offset 40 on the section grid as shown. Enter the target distance of 40.
In this example, the section lines for the existing and design surfaces have a gap at the center median. In order to have sections for both the left and right sides of the road, these separate section lines need to be connected. Run the Join Nearest command from the Edit menu. Set the max separation to 5 to have enough to span the gap. Fill out the rest of the options as shown. Then pick the existing and design section lines on the left and right sides.
Now that the drawing has the section lines, run Create Sections from Polylines on Section Grids. In the options dialog, set the horizontal and vertical scales to match the section grid. The ratio between horizontal and vertical scales is used to determine the vertical exaggeration. Set the .sct file name for the first section for the existing ground. Turn on the option to create a second section and set the file name for the design surface. Then pick OK.

The program then prompts for the station to create and the grid elevation. Then pick the section grid point at the zero offset and that elevation. Then pick the existing and design surfaces. Repeat this input for the other stations.

Exit/Pick text/<Station <0.00>>: 1880
Pick point at starting elevation and zero offset of section ([Enter] for none): pick the section grid for station 1+880 at offset 0 and elevation 0
Select station 1880.00 1st section polyline: pick the existing ground line
Select station 1880.00 2nd section polyline: pick the design surface line
Exit/Pick text/<Station <1882.00>>: 1900
Pick point at starting elevation and zero offset of section ([Enter] for none): pick the section grid for station 1+900 at offset 0 and elevation 5
Select station 1900.00 1st section polyline: pick the existing ground line
Select station 1900.00 2nd section polyline: pick the design surface line
Exit/Pick text/\(\text{Station} <1902.00>\): E for exit

There are several ways to verify the section data. Use Draw Section File to plot the sections and compare to the original PDF. Use Section Report to print out the station, offset and elevation section data. Use Input-Edit Section File to show a graphic preview of the sections along with a spreadsheet of the values. The dialog here shows the Input-Edit Section file screen for both the existing and design surfaces.

This lesson imports cross sections from a PDF into Carlson .SCT format. PDF files can contain different types of data. Some PDF's contain linework vectors and others have images. For linework data, the program brings the linework into the drawing. For images, the program can either insert the image into the drawing or run a raster-to-vector conversion process to create linework in the drawing. In this first example, the PDF file contains linework.

To begin, run the Import PDF File command in the Tools->Import/Export menu. This command requires you have the program ghostscript installed. For instructions on installing ghostscript, see the Import PDF File portion of this manual. The program starts by selecting the PDF file to import. Then there is an options dialog. Turn on the Use Colors, Join Nearest and Reduce Vertices options as shown. Then pick Insert Linework.
Then the program reads the PDF file to determine the number of pages and let's you select the range to import.

Next, the program prompts for a point to place the linework from the PDF into the drawing. Pick a point in a blank area of the drawing. Then enter the rotation angle. In this case, enter 90 for the rotation. Finally, enter the scale. At this point, we don't know the scale. So enter 1 and we will scale later.

**Pick point to insert PDF:** *pick a point*

**Specify rotation angle <0.0>:** 90

**Specify scale <1.0>:** press Enter

The next step is to scale the drawing to match the scale of the section sheets. From the Edit menu, choose 2D Scale. Use the Screen Pick option to set the scale factor. This routine prompts to pick two points from the drawing and then enter the correct distance between these two points. Pick two points with a known distance such as two points on the section grid. It's best to pick two points that are far apart to reduce errors with screen picking precision. For this example, pick at offset 0 and at offset 40 on the section grid as shown. Enter the target distance of 40.

**Calculate Scale Factor:**

- Drawing distance is 15.730.
- Enter target distance:
  - 40
  - OK
In this example, the section lines for the existing and design surfaces have a gap at the center median. In order to have sections for both the left and right sides of the road, these separate section lines need to be connected. Run the Join Nearest command from the Edit menu. Set the max separation to 5 to have enough to span the gap. Fill out the rest of the options as shown. Then pick the existing and design section lines on the left and right sides.
Now that the drawing has the section lines, run Create Sections from Polylines on Section Grids. In the options dialog, set the horizontal and vertical scales to match the section grid. The ratio between horizontal and vertical scales is used to determine the vertical exaggeration. Set the .sct file name for the first section for the existing ground. Turn on the option to create a second section and set the file name for the design surface. Then pick OK.

The program then prompts for the station to create and the grid elevation. Then pick the section grid point at the zero offset and that elevation. Then pick the existing and design surfaces. Repeat this input for the other stations.

Exit/Pick text/<Station <0.00>>: 1880
Exit/Pick text/<Starting elevation of grid <100.00>>: 0
Pick point at starting elevation and zero offset of section ([Enter] for none): pick the section grid for station 1+880 at offset 0 and elevation 0
Select station 1880.00 1st section polyline: pick the existing ground line
Select station 1880.00 2nd section polyline: pick the design surface line
Exit/Pick text/<Station <1882.00>>: 1900
Exit/Pick text/<Starting elevation of grid <0.00>>: 5
Pick point at starting elevation and zero offset of section ([Enter] for none): pick the section grid for station 1+900 at offset 0 and elevation 5
Select station 1900.00 1st section polyline: pick the existing ground line
Select station 1900.00 2nd section polyline: pick the design surface line
Exit/Pick text/<Station <1902.00>>: E for exit

There are several ways to verify the section data. Use Draw Section File to plot the sections and compare to the original PDF. Use Section Report to print out the station, offset and elevation section data. Use Input-Edit Section File to show a graphic preview of the sections along with a spreadsheet of the values. The dialog here shows the Input-Edit Section file screen for both the existing and design surfaces.
1.2

Chapter 17. Tutorials

3381
Introduction

Carlson Civil Suite encompasses all of the functionality of Survey, Site Grading, Road Design, Hydrology and GIS, along with a comprehensive set of drafting and annotation tools. Carlson Civil Suite runs atop any installed AutoCAD executable, running as plain AutoCAD, or found within Map, Land Desktop or Civil 3D as well as IntelliCAD.

Evolved from the Carlson SurvCADD product line, first introduced in 1989, Carlson Civil Suite introduces several brand new state of the art tools, including a dynamic road design program called Road Network, and a dynamic storm drain design program called HydroNet. While these functions automatically respond to design changes, adjusting sections, profiles, and grading, Carlson Civil Suite accomplishes this automation without introducing custom objects, so sharing drawings with others is not an issue.

Carlson Civil Suite continues the Carlson Software tradition of unlimited free tech support, so when needed, help is always a free phone call away, and also introduces the newest support technology in the form of an online, web-based reference manual, complete with demonstration and training movies.

Data File Types and Storage

Carlson Civil has a similarity to Land Desktop in the use of external files to store design data, but differs significantly in that in Carlson Civil the naming and placement of these files is determined by the user, not the software. Carlson Civil offers three distinct methods of file storage, the choice is up to the end user. Carlson Civil data files can either be placed in a single location, known as a data folder, placed with the drawing they are associated with, or placed in a user-defined folder structure. The placement of files within that structure is also totally user-defined, based on the assignment of file types (extensions) to folders.
File types used by Carlson Civil include:

- .crd - Point data, coordinate file
- .rw5 - raw survey data, contains all observations
- .cl - centerline, describes a 2D alignment
- .tin - Surface, newer format, more efficient than .flt in most cases, especially for machine control
- .flt - Surface, original format
- .grd - Surface grid file, used for volumes
- .cfg - Stores configuration settings
- .fld - Field to Finish file, stores rules for inserting symbols for points (LDT Description Key functionality) and automated linework functionality (Autodesk Survey Figures equivalent)
- .lot - Lot file, stores parcel geometry
- .adf - Annotation Default file
- .pro - Profile file
- .mxs - Section Alignment file
- .grp - Point Group definitions
- .rdn - Roadway Networks
- .sct - Road Sections
Settings

Carlson Civil uses several techniques to store settings. There are three main categories of settings: Drawing Setup settings, such as drawing scale and units, Command-specific settings, such as the layer to draw contours on, and Generic control settings, such as whether to link drawing points to the external coordinate file (.CRD).

Drawing Setup settings are stored directly within the drawing files (.DWG). Carlson Civil also creates a file for each drawing using the drawing name with a (.INI) file extension. This file stores a list of all of the design files that are used or created from within the drawing, such as centerline files (.CL), profile files, (.PRO), etc.

Command-specific settings are stored within a set of files with (.INI) file extensions, with the command name as a filename, such as roadnet.ini, or mapcheck.ini. These are typically stored in the \USER folder, and are created as the commands are first accessed.

Generic control settings are stored within a special (.INI) file named Carlson.ini. When new drawings are created, this file is read to set these type of generic controls.

Drawing Setup settings can be accessed directly from the Settings menu, or through the Configure command. If the Drawing Setup dialog is accessed through the Configure command, when exiting the main Configure dialog, the user is prompted whether to save changes to Current and Future drawings, or Future drawings only. Current and Future saves the Drawing Setup settings to the current drawing internally, and updates the Carlson.ini file, while the choice of Future Only does not affect the current drawing, only the Carlson.ini file, and therefore any new drawings created. To change Drawing Setup settings for only the current drawing, do not go through Configure, but use the Drawing Setup command directly off of the Settings menu.

Command-specific settings are accessed when the commands are actually run. The settings displayed are being read from the command's own specific (.INI) file, and any changes made are written to the same files. This way the commands automatically recall the settings that were used for the previous run. Alternatively, the Configure command can be used to access command-specific settings.

The Configure command provides access to a dialog box with 12 buttons, each leading to settings for specific aspects of the software. Changes made within any of these are also automatically saved to the corresponding command (.INI) file, or to the Carlson.ini file in the case of generic settings. The Configure command also provides a Save and Load functionality, utilizing configuration files (.CFG). Saving a configuration file (.CFG) saves all settings currently stored in all of the command-specific (.INI) files, and the Carlson.ini file. Loading a configuration file (.CFG) sets all settings within all these files.
Survey

The complete range of Survey functionality is contained within the Carlson Civil, and is also available in the Carlson Survey program. This includes communication with data collectors, editing and processing of raw survey data, including traverse adjustment, and Field to Finish, which controls the generation of point symbols and linework.

Land Desktop uses Description Keys for point-based symbol insertion, and Autodesk Survey uses Figure notation for the generation of linework. Autodesk requires field coding to produce linework, and the processing of that information takes place when the raw file (.fbk) is Imported. Carlson inserts symbols and linework with one function.
known as Field to Finish (F2F), and performs this task using the point descriptions from the coordinate file, not the raw observations file. So linework can actually be generated from any set of points, even if no field coding has taken place. However, the addition of field coding can certainly make the generation of linework more precise. Carlson Civil can use LDT Description Key file to start a Field to Finish Code File.

![Field to Finish (F2F) tool](image)

### Field to Finish

<table>
<thead>
<tr>
<th>CODE</th>
<th>FULL NAME</th>
<th>DESC</th>
<th>SYMBOL</th>
<th>LINETYPE</th>
<th>ENTITY</th>
<th>TIE</th>
<th>LAYER</th>
<th>ON/OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIGN</td>
<td>SIGN</td>
<td>SIGN</td>
<td>spt17</td>
<td>BVLAVER</td>
<td>Point</td>
<td>Open</td>
<td>SIGN</td>
<td>On</td>
</tr>
<tr>
<td>SHD</td>
<td>TOP OF CUR</td>
<td>SHD</td>
<td>spt10</td>
<td>BVLAVER</td>
<td>3DLine</td>
<td>Open</td>
<td>CURB-TOP</td>
<td>On</td>
</tr>
<tr>
<td>MLK</td>
<td>SIDEWALK</td>
<td>SW</td>
<td>spt10</td>
<td>BVLAVER</td>
<td>2DLine</td>
<td>Open</td>
<td>SIDEWALK</td>
<td>On</td>
</tr>
<tr>
<td>---</td>
<td>UTILITIES</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>W0G</td>
<td>W0G</td>
<td>W0G</td>
<td>spt39</td>
<td>CONTINUOUS</td>
<td>Line</td>
<td>Open</td>
<td>UTILITY</td>
<td>On</td>
</tr>
<tr>
<td>MH</td>
<td>MANHOLE</td>
<td>MANHOLE</td>
<td>spt34</td>
<td>sewer</td>
<td>2DLine</td>
<td>Open</td>
<td>SEWER</td>
<td>On</td>
</tr>
<tr>
<td>SMH</td>
<td>SMH</td>
<td>SMH</td>
<td>spt50</td>
<td>CONTINUOUS</td>
<td>Line</td>
<td>Open</td>
<td>SEMER</td>
<td>On</td>
</tr>
<tr>
<td>TELBOX</td>
<td>TELBOX</td>
<td>TELE</td>
<td>spt30</td>
<td>CONTINUOUS</td>
<td>Line</td>
<td>Open</td>
<td>UTILITY</td>
<td>On</td>
</tr>
<tr>
<td>BOX</td>
<td>BOX JUNCTI BOX</td>
<td>BOX</td>
<td>spt30</td>
<td>BVLAVER</td>
<td>Point</td>
<td>Open</td>
<td>UTILITY</td>
<td>On</td>
</tr>
<tr>
<td>CATU</td>
<td>CABLE TU CATU B0</td>
<td>spt29</td>
<td>BVLAVER</td>
<td>Line</td>
<td>Open</td>
<td>UTILTY</td>
<td>On</td>
<td></td>
</tr>
<tr>
<td>CB</td>
<td>CATCH BASI CB</td>
<td>spt66</td>
<td>BVLAVER</td>
<td>Line</td>
<td>Open</td>
<td>DRAINAGE</td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>
Carlson Civil also has powerful functions to Enter Deeds to draw linework, and a Deed Reader which reads a text file of a deed and extracts the data needed to define and draw the deed in the drawing.
Carlson Civil also has a sidebar COGO function called Visual COGO to enter Traverse, Sideshot and other survey data.
Points and Point Groups

This use of point data in Carlson Civil revolves around the use of .crd files, also known as coordinate files.

Carlson Civil supports the creation of Point Groups similar to LDT and applies them in many applications, such as using them to create surfaces, editing and listing. Carlson Civil stores Point Group definitions are associated individually to each .crd file.
Surfaces and Contours

In Carlson Civil, Surfaces can be written out as external files, but a lot of design and computations involving surfaces can also be accomplished directly within the drawing without writing out external files. Triangulation surfaces can be written out as .tin or .flt and grid surfaces as .grd files. When an external file is generated, a named Surface is also stored in the drawing. This named Surface is accessed through the Surface Manager, where it can be edited.

The main Carlson Civil command for working with Surfaces is called Triangulate and Contour. It is a single dialog box with four tabs, and covers the entire process of specifying the general settings to generate the Surface, creating Contours, generating Labels, and specifying the data source(s) for the Surface.
In Carlson Civil, Contours are generated as regular AutoCAD Polylines. Contours can be generated and automatically labeled simultaneously, or labeled after they are generated. Labels can be generated with wipeouts to hide the contour beneath them, and can also be slid along the contour to easily change their location.

The Triangulation Surface Manager has tools to edit, add and remove data points and breaklines and update the triangulation dynamically. It also allows you to change the display properties for the triangulation, contours and labels.

The TIN Utilities function provides a powerful set of editing tools.
Line and Curve Labeling

Carlson Civil refers to the process of labeling lines and curves as Annotation. Lines and curves can be labeled in a dynamic or static mode, depending on the label settings.

There is also a powerful set of tools to check for and correct overlapping labels.
Volumes

There are several ways to generate volumetric calculations within Carlson Civil. Volumes By Layers, Volumes by Triangulation, Calculate Section Volumes and Two Surface Volumes (Grid volumes).

Volumes by Layers is potentially the quickest method. It needs no existing data files and creates no files in the process. You simply specify which layers to use for each of the 2 surfaces.

Volumes by Triangulation uses two triangulated surface files as the source of the data. These files are created through the Triangulate and Contour command. You can choose to create contours in the drawing when you create the TIN files, or just create the files without generating contours.

Calculate Section Volumes calculates volumes by end areas from two cross section files.

The Two Surface Volumes method uses two predefined Surface files as the data source for the calculations.

Once calculated, you can generate Cut and Fill Color Maps, Cut and Fill Centroids, and Cut and Fill Labels to illustrate the volumes.

Alignments

Horizontal Alignments in Carlson Civil are known as Centerlines. They are stored in .cl files. They can be created and edited through the Input-Edit Centerline File command. Polylines can be drawn first and then used to define Centerlines. Once defined as a centerline, double-clicking on the polyline invokes the Input-Edit dialog box.
Profiles

Profiles are stored within .pro files, with user-defined names. Existing Ground/Surface Profiles and Proposed Finished Grade/Design Profiles both use this filetype. Multiple .pro files can be drawn on the same Profile Grid.

There are several different routines for creating profiles including Profiles From Triangulation Files, Profile From Surface Entities and Profile From Points On Centerline. Before using these profile creation routines, the horizontal alignment needs to be created as a centerline file or polyline. The Quick Profile routine can be used to create profiles in one step.
When using Process Road Design or RoadNet, the existing ground Profile can be generated automatically as part of the process, simply by specifying the Surface to use, and so is not a separate prerequisite. The Proposed Finish Grade Profile can then be added in the editor, and the Roadway processed, all without ever drawing anything in the drawing itself. The more traditional LDT approach of generating an existing ground Profile in the drawing and then adding a proposed finish grade Profile by drawing on it in the drawing is also an option.

**Roadway Cross Sections**

Roadway Cross Sections are based on Cross Section Alignments (.mxs files) that are defined by the Input-Edit Section Alignment command to set the station interval and max offsets left and right. Similar to profile creation, there are several routines to create sections including Sections From Triangulation, Sections From Surface Entities and Sections From Points. The Process Road Design and RoadNet commands can create final sections.

Once section files (.sct) are created, the Input-Edit Section File command allows you to review and edit the section data. Also the Draw Section File and Section Report commands can be used.
Roadway Templates

Roadway Templates are created within the Design Template dialog box. They are stored as .tpl files, and can be applied to any road design. Templates are used in Process Road Design, Road Network and within the Input-Edit Road Profile dialog.

The Design Template defines the road grades, subgrades, curb, superelevation break points and cut/fill slope treatments.
Design Control

The idea of Design Control in LDT exists in Carlson Civil in a number of places.
• Template Control - Templates are assigned to centerlines either in the Process Road Design dialog box, or in the Input-Edit Road Profile dialog.
• Slope Control - In Carlson Civil, side slopes are actually part of the Template definition.
• Ditches - Ditches are defined within the Design Template as part of the cut/fill treatment.

Transitions - There are four methods to work with Transitions in Carlson Civil.

The first is called a Template Series, in which multiple Templates are assigned to a single Centerline at different stations. Next is a Template transition, in which a single Template is assigned to the entire Centerline and the user edits it at different stations. Next is a Template Point Centerline, in which a secondary Centerline is defined and attached to a point on the Template for specific horizontal control, such as a lane widening. Last is a Template Point Profile, in which an additional Profile is defined and attached to a point on the Template for specific vertical control, like the flow line of a ditch.

Superelevations - The template breakpoints for superelevation pivots are defined within Design Template. The stations for the superelevation transitions are set in the Input-Edit Superelevation command.

**Roadway Intersections**

One of the very exciting features of Carlson Civil is the use of Roadway Networks. These are sets of centerlines that are aware of each other and clean up at intersections, horizontally and vertically.
Cul-de-sacs

Cul-de-sacs are handled elegantly with the Road Network. Cul-de-sacs can be easily added to any roadway, and designed at a very detailed level, including a profile for the circumference.
Grading

Carlson Civil includes a variety of tools to accomplish the task of grading, including point commands, 3D polylines commands, contour commands and a grading mechanism known as a Pad Template, which is essentially the equivalent of an LDT Grading Object. Pad Templates provide some significant improvements, however, such as the ability to have a separate surface for the area inside the "pad", which moves horizontally and vertically with edits to the pad, and the ability to use a template for the side slopes, so they can project complex grading designs.

LandXML Data Transfer

Transfer of data between LDT and Carlson Civil can be accomplished in several ways, depending on the type of data in question, but the best overall method is the use of LandXML files.

Pipes

Pipe Profiles can be designed and edited in the Input-Edit Profile dialog, and then drafted in the drawing. In Hydrology, Pipe Networks can be created, which are dynamic and "intelligent", and so automatically respond to design changes.

Lots

Carlson Civil includes a set of tools for lot layout and lot design. Defined lots can be stored in a lot file (.lot). Another way to define a set of Lots automatically is with the Lot by Enclosed Text command, which searches for closed areas with enclosed text, and creates lots out of them, using the enclosed text for the lot name/number. Defined Lots can be accessed and edited through the Lot Editor.
In LDT, as part of drawing setup, a set of text styles is created based on information contained in a file with a .STP file extension, most commonly used is the LEROY.STP. These text styles all have fixed heights assigned to them.
based on the current horizontal scale set in the drawing. If the horizontal scale is changed, the heights of the text styles are all changed.

In Carlson Civil, each of the various commands that involve annotation set the text style to be used and the desired height for the text, using a "scaler", which is multiplied by the current drawing scale. The AutoCAD text style should be set with a height of zero.

**North Rotation**

Carlson Civil does not support the concept of a secondary UCS to define and store North, as is done with LDT North Rotation. Instead, Carlson Civil relies on the use of DVIEW Twist to reorient North, and contains a thorough set of tools to work with that command. Any LDT drawings that are going to be brought into Carlson Civil should first have their LDT Base Point and North Rotation checked. If they are not all zeros, they should all be set to 0, have all points inserted to the drawing, and all linework moved and rotated to the location of the points.

**Drawing Cleanup**

If you're not running Carlson Civil on top of Map, or even if you are, Carlson Civil includes an awesome Drawing Cleanup function to find and resolve a wide range of common drawing problems.
Programming Interfaces
LSP Functions

Overview

Many of the Carlson functions and program environment settings are defined in LSP. These functions and variables are available for you to use in your own LSP routines.

The following is a list of useful functions:

scad_getfiled - file selection dialog

The following is a list of useful variables:

lsppdir$ - Carlson LSP folder where program files are located (string)
tmpdir$ - current project data folder (string)
psname - Carlson Support folder (string)
sv:sm - horizontal scale (real)
sv:vs - vertical scale (real)
sv:ts - text size scaler (real)
sv:ps - symbol size scaler (real)
is_metric - english/metric mode (0=english, 1=metric)
crdfile - current coordinate file (string)

scad_getfiled

Runs a file selection dialog. The function returns a string of the selected file name

Usage: (scad_getfiled title folder extension mode)

title - A string for the dialog title
folder - A string for the initial default folder
extension - A string for the file type extension
mode - An integer for the selection mode (0 = existing file, 1 = new file)

Example: (setq file_name (scad_getfiled ''Pick Surface To Process'' tmpdir$ ''tin'' 0))

Coordinate API

Overview

We have created a Lisp file, CrdAPI.FAS, that contains some simple and easy-to-use functions for accessing, modifying, drawing and selecting any type of coordinate file that Carlson Software supports. The CrdAPI.FAS file is located in the Carlson LSP folder. This collection of functions can help you write your own tools. We call this toolkit the Coordinate File Application Programming Interface, or CRD API.

This document describes the Lisp interface of the CRD API.
Supported Types of Coordinate Files

The following enumerated variables are available for specifying the different types of coordinate files that are supported by the CRD API.

;;; Coordinate File format number

(setq
  enCrdTypeUnrecognized -2 ; file exists but is not a recognized type.
  enCrdInvalid -1 ; not a valid type - used in creating new files.
  enCrdSurvCADDNumeric 0 ; Carlson original; point name is numeric. Extension 'crd'.
  enCrdSurvCADDAlpha 1 ; Carlson sequel; point names can be alphanumeric. Extension 'crd'.
  enCrdMemory 2 ; NOT YET IMPLEMENTED.
  enCrdCgAlpha 3 ; C&G alphanumeric. Extension 'cgc'.
  enCrdCgNumeric 4 ; C&G numeric. Extension 'crd'.
  enCrdSimplicity 5 ; Simplicity 'Sight Survey'. Extension is 'zak'.
  enCrdLDD 6 ; Land Desktop Development. Filename is 'points.mdb'.
  enCrdCivil3D 7 ; Civil 3D; point name is numeric.
  enCrdSQLite 8 ; Carlson SQLite. Extension 'crdb'.
)

Working with Points in Coordinate Files

The following functions are for working with Crd Point structures.

Internally, the Crd Point looks like the following list.

(name desc x y z)

To allow for expansions and changes of the Crd Point in the future, please use only the following Crd Point functions for setting and accessing Crd Points.

CrdPointInit

A Crd Point structure will be returned that can be passed into CrdAddPoint, etc. name and desc must both be strings.

(defun CrdPointInit( x y z name desc)
  (list name desc x y z)
)

CrdPointSetName

Sets the name of the Crd Point structure. The Crd Point is returned.

(defun CrdPointSetName( point name)
  (cons name (cdr point))
)

CrdPointGetName

Gets the name of the Crd Point structure.

(defun CrdPointGetName( point)
  (car point)
)
CrdPointSetDesc
Sets the description of the Crd Point structure. The Crd Point is returned.
(defun CrdPointSetDesc( point desc)
  (cons (car point) (cons desc (cddr point)))
)

CrdPointGetDesc
Gets the description of the Crd Point structure.
(defun CrdPointGetDesc( point)
  (cadr point)
)

CrdPointSetXYZ
Sets the x, y, z values of the Crd Point structure given a list of (x y z). The Crd Point is returned.
(defun CrdPointSetXYZ( point xyz)
  (append (list (car point) (cadr point)) xyz)
)

CrdPointGetXYZ
Gets the x, y, z values of the Crd Point structure as a list of (x y z).
(defun CrdPointGetXYZ( point)
  (cddr point)
)

Working with the Coordinate File

The following functions are for working with coordinate files.

CrdOpen
Opens a coordinate file with the given filename. Only one coordinate file can be open at a time through the Lisp interface. If CrdOpen is called twice, the first crd file is closed automatically.

filename  – The file name of the coordinate file with required extension (.crd, .cgc, .mdb).
bOverwrite – If 1 (integer), then any existing file of the same name will be destroyed. Use nil to select default value which is 0.
crdType  – See enCrdType above. This specifies the type of CRD file to create if the given name does not already exist. Use nil to select the default value which is enCrdSurvCADDAlpha.
Returns 1 (integer) if successful and 0 if there was some kind of failure. Call CrdGetLastError() to get the text message of the error.
(defun CrdOpen( filename bOverwrite crdType)
  (cf:crdapi ''CrdOpen'' filename bOverwrite crdType)
)

CrdClose
Closes the current Crd file, if it is open.
(defun CrdClose()
  (cf:crdapi ''CrdClose'')
)

CrdAddPoint
Adds the given Crd Point to the current open Crd File, overwriting any point with the same name that may already exist. Returns 1 (integer) if successful and 0 otherwise. Call CrdGetLastError() to get text message of error.
(defun CrdAddPoint( point)
CrdBegin
Starts a traversal of all the points of the Crd File by resetting internal state so that CrdNext will start from beginning of file.

range – if not nil, then it must be a Carlson-style string of point names suggested by the following examples: "1-5,6,12-19" or "all". If nil, that is the same as all. The points will be returned on successive calls to CrdNext() in the order listed in the range.

(defun CrdBegin( range)
  (cf:crdapi 'CrdBegin'' range)
)

CrdNext
Gets the next point in the Crd File. Returns a Crd Point if successful and nil if there are no more points or some other failure.

(defun CrdNext()
  (cf:crdapi 'CrdNext'))

CrdGetPoint
Gets the named point from the current open Crd File. A Crd Point is returned if successful and nil is returned if the point could not be found. Call CrdGetLastError() to get text message of error.

(defun CrdGetPoint( name)
  (cf:crdapi 'CrdGetPoint'' name)
)

CrdRemovePoint
Removes the named point from the current open Crd File. Returns 1 (integer) if successful and 0 otherwise. Call CrdGetLastError() to get text message of error.

(defun CrdRemovePoint( name)
  (cf:crdapi 'CrdRemovePoint'' name)
)

CrdRemovePoints
Removes the given range of points (a string) from the current open Crd File. For example, the range could be "1-5,7,10-12".

(defun CrdRemovePoints( range)
  (cf:crdapi 'CrdRemovePoints'' range)
)

CrdTestPointName
Returns nil if the point name is valid for the current Crd type. Otherwise, returns an error string describing the error.

(defun CrdTestPointName( name)
  (cf:crdapi 'CrdTestPointName'' name)
)

CrdTestPoint
Returns nil if the Crd Point is valid for the current Crd type. Otherwise, returns an error string describing the error.

(defun CrdTestPoint( point)
  (cf:crdapi 'CrdTestPoint'' point)
)

CrdGetLastError
Returns the error string of the result of the last operation.
(defun CrdGetLastError()
  (cf:crdapi 'CrdGetLastError))
}

CrdDeleteFile
Deletes the data file(s) underlying the Crd File and closes the Crd File. May not work if the original filename was
not a full path including drive letter. Returns 1 (integer) if successful and 0 otherwise. Call CrdGetLastError() to
get text message of error.
(defun CrdDeleteFile()
  (cf:crdapi 'CrdDeleteFile))
}

GetCrdType
Returns the crd type of the current open Crd File.
(defun GetCrdType()
  (cf:crdapi 'GetCrdType))
}

GetCrdTypeName
Returns the official name of the given crd type.
(defun GetCrdTypeName(enCRDType)
  (cf:crdapi 'GetCrdTypeName enCRDType))
)

CrdDraw
Accepts an argument list to indicate a set of points to be drawn, which at a minimum takes the form '(['Points'
' '<points designator>']].
(defun CrdDraw(arglist)
  (eval (append '(cf:crdapi 'CrdDraw') arglist)))
)

The syntax for additional optional parameters which may be included in arglist (indicated by "[]") is as fol-
llows:
(CrdDraw '(''Points' ' '<points designator>''
[''SymbolName' ' '<symbol block name>''
[''SymbolXScale' ' '<X scale>]
[''SymbolYScale' ' '<Y scale>]
[''SymbolRotation' ' '<symbol rotation in AUNITS>''
[''SymbolLayer' ' '<symbol layer name>''
[''BlockName' ' '<attribute block name>''
[''BlockXScale' ' '<X scale>]
[''BlockYScale' ' '<Y scale>]
[''BlockRotation' ' '<attribute block rotation in AUNITS>''
[''BlockNameLayer' ' '<layer for point name>''
[''BlockElevationLayer' ' '<layer for point elevation>''
[''BlockDescriptionLayer' ' '<layer for point description>''
[''PointLayer' ' '<layer for POINT>''])
)

CrdSelect
Accepts an argument list to indicate a set of points to be selected, which at a minimum takes the form nil to select
all points.
The syntax for additional optional parameters which may be included in arglist (indicated by "[]") is as follows:

(CrdSelect '( ; Select all points in drawing
[''Points'' ''<points designator>'']) ; Select all points in <point
designator>
[''Prompt'' ''<prompt for points>'']) ; Interactive (spatial) select points in drawing
[''P0'' point ''P1'' point] ; Select all points in window having corners P0,P1
)

Note that all optional parameters within "[]" are mutually exclusive. The function returns the selected points as a list of points, each of which is itself a sublist indicating the point identifier and its associated drawing entity name.

Example Code

;;;; Examples on how to use.
(CrdOpen "junk2.crd" nil nil)
(princ (strcat "Created a file of type: " (GetCrdTypeName (GetCrdType)) "\n"))

; create a couple of points in memory.
; This first point is at coordinate 100,101,10.5 and has the point name
; of 1012 and the description of IP.
(setq point1 (CrdPointInit 100 101 10.5 ''1012'' ''IP''))
(setq point2 point1)
(setq point2 (CrdPointSetXYZ point2 '(105 101 10.5)))
(setq point2 (CrdPointSetName point2 ''3''))
(setq point3 (CrdPointSetName point2 ''7''))

; adding a point and checking for errors.
(setq bSuccess (CrdAddPoint point1))
(if (= bSuccess 0)
(princ (strcat "Error on point " (CrdPointGetName point1) ": "
(CrdGetLastError)) "\n")

; adding points without checking for errors.
(CrdAddPoint point2)
(CrdAddPoint point3)

; now print out the points 1 through 5
(princ "Listing the point names.\n")
(CrdBegin "1-5") ; nil or "all" would select all the points.
(while (setq point (CrdNext))
(princ (strcat (CrdPointGetName point) " " (CrdPointGetDesc point) "\n"))
)
;
; Drawing points.
; Draw all points in the drawing using defaults. Argument list '<<Points''
'"'<points designator>'') is required as a minimum.
(CrdDraw '<<Points'' 'ALL''))

; Syntax for additional optional parameters indicated by '[]' is as follows:
; (CrdDraw '<<Points'' '<points designator>'
; ["SymbolName'' '<symbol block name>'"
; ["SymbolXScale' <X scale>
; ["SymbolYScale' <Y scale>
; ["SymbolRotation'' '<symbol rotation in AUNITS>'"
; ["SymbolLayer'' '<symbol layer name>'"
; ["BlockName'' '<attribute block name>'"
; ["BlockXScale' <X scale>
; ["BlockYScale' <Y scale>
; ["BlockRotation'' '<attribute block rotation in AUNITS>'"
; ["BlockNameLayer'' '<layer for point name>'"
; ["BlockElevationLayer'' '<layer for point elevation>'"
; ["BlockDescriptionLayer'' '<layer for point description>'"
; ["PointLayer'' '<layer for POINT>''])

; Selecting points.
; Select all points in the drawing
(CrdSelect nil)

; Select all points in window
(CrdSelect '<<P0'' (setq p0 (getpoint 'First Corner: ')) 'P1'
(getcorner p0 'Opposite corner: '))

; Syntax for additional optional parameters indicated by '[]' is as follows.
; (CrdSelect '<<Points'' '<points designator>'') ; Select all points in
<point designator>
["Prompt'' '<prompt for points>'"] ; Interactive (spatial) select points
in drawing
["P0'' point 'P1'' point] ; Select all points in window
; All parameters within [] are optional and are mutually exclusive.

(CrdDeleteFile) ;the only proper way to delete the file(s). C&G uses two
files, for example.
(CrdClose) ;not necessary because of CrdDeleteFile, but doesn't hurt.
(princ ''---the end---\n'')

**DTM API**

**Overview**

A lot of functionality of Carlson triangulation and TIN file manipulation is now available from LISP for the advanced users to use in their routines. This part of the Carlson interface is called DTM API.

API supports the older FLT file format, which stores only edge information, and the new TIN format, which is a binary format containing all the structure of triangulation and therefore is faster to load and takes less space.
The file extension controls which file type is being created.

The functionality of DTM API is implemented in TRI4.ARX. It would be the responsibility of the caller to make sure that this file gets loaded by adding this line at the beginning:

```
(scload (strcat lspdir$ ''tri4''))
```

The ARX should never be unloaded by the caller.

The following is a list of currently supported functions (it can be obtained at any time by calling `(cf:dtm_api)`:

- **create_tin** - create a TIN from selection set
- **draw_tin** - draws a TIN as 3DFACEs;
- **tri_volume** - produce volume report from 1 or 2 TINs
- **tri_change** - modify tin using inc/exc and operators
- **tri_contour** - contour tin using inc/exc and ini file with settings
- **tri_profile** - creates a profile of the TIN along a centerline
- **tri_diff** - produce a difference TIN from two TINs
- **tin_combine** - produce a combined TIN performing a specified operation to elevation
- **tri_store_regions** - create and store TIN difference
- **tri_apply_region** - apply a specific region revision
- **tri_forget_region** - forget all region revisions
- **surface_util** - routines for tin surface manager
- **load_tin** - loads TIN into memory for tin_z function
- **unload_tin** - unloads the current TIN from memory
- **tin_z** - returns the z at the specified x,y for the current TIN set by load_tin

### create_tin

Creates TIN from a given selection set, optionally using inside/outside logic.

**Usage:**

```
(cf:dtm_api 'create_tin' entities_ss inclusion_ss exclusion_ss regions_ss file_name options)
```

- **entities_ss** - Selection set of all entities to be used for triangulation. Currently supported are point, line, arc, polyline, insert, circle, 3Dface, solids, text, and mtext.
- **inclusion_ss** - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.
- **exclusion_ss** - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.
- **regions_ss** - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).
- **file_name** - Full path of file to be created. Extension controls a type of TIN file created.
- **options** - Optional. String containing one or more of the following keywords, space separated:
  - **ignore_zero** - Ignore zero elevation data points.
  - **view_error_log** - In case of warnings during triangulation, bring up the report at the end.
  - **densify** - Perform ridge/valley detection and improve triangulation as needed.

### draw_tin

Draws TIN file at a given layer as 3DFACEs.
Usage: \texttt{(cf:dtm\_api 'draw\_tin' file\_name layer\_name is\_road)}

\textit{file\_name} - Full path of file to be loaded.
\textit{layer\_name} - Layer name to use. If does not yet exist, new layer will be created. Color of entities is set to \texttt{BYLAYER}.
\textit{is\_road} - Optional. If set to 1 and route follows completion of Process Road Design feature it will turn on road coloring.

\textbf{tri\_volume}

Calculates volume of the TIN within a given polyline, optionally with report generated.

Usage: \texttt{(cf:dtm\_api 'tri\_volume' inclusion\_ss exclusion\_ss regions\_ss filename filename2|elevation is\_report is\_silent)}

Return values: If successful, the function returns a list with 4 real values: cut, fill, cut area, and fill area. The volume is in cubic ft or meters and area is in square ft or meters, depending on the configuration.

\textit{inclusion\_ss} - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.
\textit{exclusion\_ss} - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.
\textit{regions\_ss} - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).
\textit{filename} - Full path of main TIN file to be used.
\textit{filename2} - Full path of secondary TIN file to be used. If used, two surface volumes will be calculated between the first and second TINs.
\textit{elevation} - Reference elevation passed as real value. If this option is used, one surface volume will be calculated between the first TIN and this reference elevation.
\textit{is\_report} - 0/1. Specifies whether to bring up the report with calculation results.
\textit{is\_silent} - 0/1. If 0 value is supplied the routine will provide no output at the command line and no progress indicators.

\textbf{tri\_change}

Change TIN file using specified optional inclusion polylines and using one of the possible math operations. For all operations but "embed" the inclusion/exclusion polylines are offset a 0.1 so that a reasonably sharp wall could be produced by modifications.

Usage: \texttt{(cf:dtm\_api 'tri\_change' inclusion\_ss exclusion\_ss regions\_ss filename operation value)}

\textit{inclusion\_ss} - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.
\textit{exclusion\_ss} - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.
\textit{regions\_ss} - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).
\textit{filename} - Full path of main TIN file to be modified.
\textit{operation} - keywords describing what operation is to be performed on the TIN:
add - Add a value to elevation of inside nodes.
scale - Scale elevation of inside nodes by the value.
set - Set elevation of inside nodes to the value specified.
perp - Sets elevation of nodes as if TIN is offset by value along normal at the point. The node is not moved horizontally, just elevation is adjusted.
nil - Removes inside nodes. No value is needed.
embed - No change of elevations, but the inclusion polyline is still added to TIN.

**tri_contour**

Contours TIN file as defined by INI file and inclusion polylines

**Usage:**

```scheme
(cf:dtm_api '"tri_contour"' inclusion_ss exclusion_ss regions_ss tin_filename ini_filename)
```

- `inclusion_ss` - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.
- `exclusion_ss` - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.
- `regions_ss` - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).
- `tin_filename` - Full path of main TIN file to be used.
- `ini_filename` - Full path of INI file defining how contouring is performed. For list of values, check tri4.ini in USER folder which stores values used in Triangulate and Contour function.

**tri_profile**

Creates a profile of the TIN along a centerline

**Usage:**

```scheme
(cf:dtm_api '"tri_profile"' tin_filename cl_filename pro_filename)
```

**Return values:** If successful, the function returns 1, otherwise nil.

- `tin_filename` - Full path of main TIN file to be used.
- `cl_filename` - Full path of centerline (.cl) file to be used.
- `pro_filename` - Full path of the profile file to be created.

**tri_diff**

Calculates difference between two TIN files and creates combined TIN with elevation being the difference of elevations. TINs do not have to match perfectly - face intersections will be performed. Inclusion logic will be applied if needed.

**Usage:**

```scheme
(cf:dtm_api '"tri_diff"' inclusion_ss exclusion_ss regions_ss filename1 filename2 diff_filename)
```

- `inclusion_ss` - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.
- `exclusion_ss` - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.
regions_ss - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).

filename1, filename2 - Full path to TIN files to be used. Second TIN is subtracted from first one.

diff_filename - Full path of differential TIN file to be created.

**tin_combine**

Combines two TINs into one while applying one of the specified operations. First two TINs are combined into one intersecting all faces which need to be intersected and then elevations are assigned as specified.

Usage: 

```lisp
(cf:dtm_api "tin_combine" inclusion_ss exclusion_ss regions_ss filename1 filename2 merged_filename operation)
```

inclusion_ss - Selection set containing inclusion polylines if needed. Pass nil if inclusion polylines are not being used.

exclusion_ss - Selection set containing exclusion polylines if needed. Pass nil if exclusion polylines are not being used.

regions_ss - Selection set containing region polylines if needed. Pass nil if regions are not being used. Regions logic is on/off - crossing region line reverses the inside/outside state. Note: Only one of inside/outside methods can be used for one call (either inclusion/exclusion or regions).

filename1, filename2 - Full path to TIN files to be used.

merged_filename - Full path to the file where results are stored.

operation - Keywords describing the operation to perform. The following operations are supported:

keep - The elevations of first TIN are used.

copy - Elevations of second TIN are used.

min - Lesser of two elevations is used.

max - Greater of two elevations is used.

join - Points inside are given elevations of first TIN, outside - second one.

**tri_store_regions**

Evaluates "before" and "after" TIN and stores "affected" area as a region with two revisions "0" and "1". The regions then can be applied as needed using other commands. This functionality only works with binary .TIN files.

Usage: 

```lisp
(cf:dtm_api "tri_store_regions" filename1 filename2 mark_name filename3)
```

filename1, filename2 - Full path to TIN files to be used.

mark_name - String label for region to be used.

filename3 - Full path to TIN files to be Save As. If omitted, the file specified by filename1 will be replaced with resulting file.

**tri_apply_region**

Applies a specific pre-stored region revision, so that when TIN file is used it has that revision of the region in use.

Usage: 

```lisp
(cf:dtm_api "tri_apply_region" filename mark_name revision)
```

filename1 - Full path to TIN file to be modified.

mark_name - String label for region to be used.
**revision** - Integer. Optional ID of revision to apply. If omitted, the latest revision of the region is used.

### tri_forget_region

Removes any knowledge of a specific pre-stored region revision from TIN file. Optionally remove triangles found in the region from the TIN.

Usage: `(cf:dtm_api 'tri_forget_region' filename mark_name remove_first)`

- **filename** - Full path to TIN file to be modified.
- **mark_name** - String label for region to be used.
- **remove_first** - 0/1. Optional flag indicating whether region triangles should be removed, leaving a hole in the TIN.

### surface_util

Utilities for dealing with surfaces stored in the drawing.

Usage: `(cf:dtm_api 'surface_util' filename operation)`

- **filename** - Full path to TIN file to be modified.
- **operation** - Keywords describing the operation to perform. The following operations are supported:
  - **check** - Check if TIN is used in one of the surfaces. Returns 0 or 1 depending on outcome.
  - **process** - Apply current surface parameters to TIN file. This function should be used to update surface in the drawing after TIN has been modified.

### load_tin

Loads a TIN into memory for use with the tin_z function.

Usage: `(cf:dtm_api 'load_tin' file_name)`

- **file_name** - Full path of file to be loaded.

### unload_tin

Unloads the current TIN from memory.

Usage: `(cf:dtm_api 'unload_tin'`)

### tin_z

Calculates the elevation of the TIN at the specified x,y location. The TIN to process must be already loaded by the load_tin command. The calculated elevation is returned to LSP on success. A nil is returned to LSP if the command arguments are invalid, a TIN is not loaded or the point is off the surface.

Usage: `(setq elev (cf:dtm_api 'tin_z' point))`

- **point** - List of doubles in x,y format
Examples:

Calculate TIN Elevation at Point

(scload (strcat lspdir$ "tri4"))
(setq file_name (scad_getfiled "Select TIN to Process" "" "tin" 0))
(cf:dtm_api "load_tin" file_name)
(setq pnt (getpoint "\nPick point:"))
(setq elev (cf:dtm_api "tin_z" pnt))
(cf:dtm_api "unload_tin")

Road API

Overview

The Road API is a collection of functions for centerline location and road design calculations. These functions are available from LISP for advanced users to use in their own routines.

The functionality of Road API is implemented in the Carlson EWORKS.ARX program file. This ARX program file must be loaded before calling the Road API functions. Use the following LSP code to load the ARX:

(scload (strcat lspdir$ 'eworks'))

The following is a list of currently supported functions (it can be obtained at any time by calling (cf:road_api):

cl_location_at_pt - calculates the station-offset and centerline position from a specified centerline and point
cl_location_at_sta - calculates the point and vectors for a specified station on a centerline
cl_sta_range - returns the stat and end stations for the specified centerline
profile_z - calculates the profile elevation for the specified station on the profile
profile_sta_range - returns the start and end station for the specified profile
road_z - calculates the road design elevation for the specified point and design files

cl_location_at_pt

Given a centerline file name and a point, this function calculates the station-offset and the projected location of the point along the centerline. On success, the function returns a list of the station, offset and projected centerline point. On failure, the function returns nil.

Usage: (cf:road_api "'cl_location_at_pt'" file_name point is_rr)

file_name - Full path of the centerline file to process (string).
point - Coordinates (x,y) of the point to process (list of reals).
is_rr - Optional integer parameter for station type (0 = roadway stations (default), 1 = railroad stations)

cl_location_at_sta

Given a centerline file name and a station, this function calculates the point on the centerline at the specified station along with the vectors for the tangent and normal of the centerline at that station. On success, the function returns a
list of the point on centerline, the tangent vector and the normal vector. On failure, the function returns nil.

Usage: `(cf:road_api ''cl_location_at_sta'' file_name station is_rr)`

file_name - Full path of the centerline file to process (string).
station - Target station to process (real).
is_rr - Optional integer parameter for station type (0 = roadway stations (default), 1 = railroad stations)

c_l_s_t_a_ r_a_n_g_e

This function simply return the starting and ending stations for the specified centerline. On success, the function returns a list of the starting station and the ending station as reals. On failure, the function returns nil.

Usage: `(cf:road_api ''cl_sta_range'' file_name is_rr)`

file_name - Full path of the centerline file to process (string).
is_rr - Optional integer parameter for station type (0 = roadway stations (default), 1 = railroad stations)

p_r_o_f_i_l_e_z

Given a profile file name and a station, this function calculates the elevation on the profile at the specified station. On success, the function returns the elevation. On failure, the function returns nil.

Usage: `(cf:road_api ''profile_z'' file_name station)`

file_name - Full path of the profile file to process (string).
station - Target station on profile (real).

p_r_o_f_i_l_e_s_t_a_ r_a_n_g_e

This function simply returns the starting and ending stations for the specified profile. On success, the function returns a list of the starting and ending stations as reals. On failure, the function returns nil.

Usage: `(cf:road_api ''profile_sta_range'' file_name)`

file_name - Full path of the profile file to process (string).

r_o_a_d_z

This function calculates elevation of a road design at the specified point. The road design is defined by the design files names. The centerline, profile and template files are required. The other design files are optional. On success, the function returns the elevation. On failure, the function returns nil.

Usage: `(cf:road_api ''road_z'' point cl_file pro_file tpl_file sup_file tpt_file tpc_file tpp_file)`
point - Coordinates (x,y) of the point to process (list of reals).
cl_file - Full path of the centerline file (string).
pro_file - Full path of the profile file (string).
tpl_file - Full path of the template file (string).
sup_file - Full path of the superelevation file (string).
tpt_file - Full path of the template transition file (string).
tpc_file - Full path of the template point centerline file (string).
tpp_file - Full path of the template point profile file (string).

3D Viewer API

Overview

It is now possible to call 3d viewer from LISP for the advanced users to use in their routines.

The functionality of 3D Viewer API is implemented in CUBE.ARX. It would be the responsibility of the caller to make sure that this file gets loaded by adding this line at the beginning:

```lisp
(scload (strcat lspdir$ ''cube''))
```

Displaying a selection set of entities

Prompts the user for a selection set and displays it in a 3d viewer window

Usage: `(cf:sc3dview)

Loading a surface file into 3D viewer

Loads the surface given as grid (.GRD) or triangulation (.FLT or .TIN) file.

Usage: `(cf:sc3dview file_name)
Index

plus-0.5in
2 Point - 2 Point Intersect, 589
2 Tangents, Arc Length, 162
2 Tangents, Chord Length, 163
2 Tangents, Degree of Curve, 164
2 Tangents, External, 164
2 Tangents, Mid-Ordinate, 163
2 Tangents, Radius, 162
2 Tangents, Tangent Length, 164
2 Tangents, Through Point, 165
2D Align, 115
2D Polyline, 152, 154, 248, 644, 645, 1269, 1272
2D Polyline by Points, 1053, 1991
2D Polyline by Screen Entities, 1052
2D Polyline by Start-End Elevations, 1995
2D Polyline by Start/End Elevations, 1056
2D Polyline by Surface Model, 1052, 1158
2D Polyline by Text, 1053
2D Polyline by Text With Leader, 1054
2D Polyline-By Text, 1991
2D-1D Local Coordinate System, 473
2D-1D State Plane Coordinate System, 481
3 Point, 160, 170, 596
3-Radius Curve Series, 168
3D Data Menu, 1048
3D Dragline, 2910
3D Drive Simulation, 1963, 1964, 3290, 3305
3D Entity By Surface Model, 1059
3D Entity to 2D, 135, 1048, 3165
3D GeoFluv Contour Viewer, 2331
3D GeoFluv Surface Viewer, 2333
3D Polyline, 131, 133, 135, 155, 159, 204, 515, 516
3D Polyline by Slope on Surface, 1085, 3154, 3159
3D Polyline Flow Values, 1635, 3222
3D Polylines, 19, 133, 136
3D Viewer API, 3419
3D Viewer Window, 139, 145, 227, 1110, 1221, 1223
3D Scale, 107, 108
AASHTO, 1250, 1283, 1301, 1482
Action Tab, 2193, 2197, 2202, 2206, 2208, 2209
Add Culvert to Polyline, 757
Add Grid Lines, 1345
Add Grid Ticks and Dots, 1344
Add Intersection Points, 119
Add Link, 1870
Add Pin Point, 2741
Add Point by Two Slopes, 133
Add Points At Elevation, 125, 1089
Add Polylines, 19, 133, 136
Add Polyline Arcs, 120
Add Polyline Vertex, 120
Add Profile, 2331
Add Strata, 2414, 2917
Add Zig to Polyline, 757
Adder Text, 724, 726
Adjust Draw Profile Settings, 1346
Adjust Elevation Labels, 1075
Adjust Overexcavate Surface, 1923
Adjust Plan/Profile Sheet, 1346
Align by Two Pairs of Points, 277
Align GPS To Local Coordinates, 2118
Alignments, 3394, 3396
Align Points, 273, 281, 297
Advanced Projections, 2651, 2727, 2770, 2772, 2788
Advanced Weir Design, 1694, 1696, 1697
Add Core Hole, 2648
Add Culvert to Polyline, 757
Add Grid Lines, 1345
Add Grid Ticks and Dots, 1344
Add Intersection Points, 119
Add Link, 1870
Add Pin Point, 2741
Add Point by Two Slopes, 133
Add Points At Elevation, 125, 1089
Add Polyline Arcs, 120
Add Polyline Vertex, 120
Add Prefix/Suffix To Text, 113
Add Strata, 2414, 2917
Add Zig to Polyline, 757
Adjoiner Text, 724, 726
Adjust Draw Profile Settings, 1346
Adjust Elevation Labels, 1075
Adjust Overexcavate Surface, 1923
Adjust Plan/Profile Sheet, 1346
Adjust Profile Grid, 1345
Adjust Overexcavate Surface, 1923
Adjust Plan/Profile Sheet, 1346
Advanced Projections, 2651, 2727, 2770, 2772, 2788
Advanced Weir Design, 1694, 1696, 1697
Align by Two Pairs of Points, 277
Align GPS To Local Coordinates, 2118
Alignments, 3394, 3396
Align Points, 273, 281, 297
All topo items, 972
Alphanumeric, 228, 260, 273, 471, 827, 3031
Angle/Distance, 294, 686, 711, 3053
Angle Balance, 350, 373, 375, 554
Angle Info, 214, 215
Angle Mode, 217, 227, 229, 577, 800
Angles Right, 894
Annotate Menu, 694
Annotation, 18, 25, 182–186, 189, 193–197, 539, 662
    708, 715, 747, 762, 980, 1095, 1307, 1745
    1877, 3384, 3393
Annotation Defaults, 695, 702, 729, 743
Apache Lightbar, 2157
Append Another Raw File, 384
Append File, 2646, 2790
Apply Faults to Grid, 2479
Apply New Definition, 2410
Arc From Last Point, 167
ArcInfo, 2697
Arc Length, 155, 159, 163, 165, 696, 728, 1029, 1030,
    1251
Arcview, 1863
Area/Layout Menu, 617, 670
Area by Closed Polylines, 625
Area by Interior Point, 625, 3092, 3099, 3100
Area by Lines & Arcs, 624, 625
Area Defaults, 618, 622–625, 628, 632, 662, 685, 686,
    3027, 3028, 3075, 3105
Area Label Defaults, 570, 627
Area Radial from Curve, 638
Areas Of Interest, 1911, 1958
Area Summary, 890
Area Table Defaults, 628, 629, 662
Area To Section Report, 2933
Arrowhead, 199, 306, 309, 1091
ASCII File, 268, 269, 773, 806, 807, 811, 1869, 1870
    2644, 2645, 2790
ASE, 43, 51, 91, 934, 1164, 1169, 1195, 1198, 1948
    1949, 1957, 2109, 2166, 2170, 2382, 3175
    3178, 3185, 3187
Assign Bed Names, 2417, 2584
Assign Contour Elevation - From Contour Labels, 2001
Assign Contour Elevation - Multiple in Series, 2000
Assign Contour Elevation - Single Elevation Group, 2002
Assign Contour Elevations: From Contour Labels, 1057
Assign Contour Elevations: Multiple in Series, 1056
Assign Contour Elevations: Single Elevation Group, 1058
Assign Directions, 2807, 2821, 2822, 2826, 2980
    2983, 2997
Assign Panel Attributes, 2720
Assign Pipe Width to Polyline, 1377, 1451
Assign Pit Attributes, 2829
Assign Pit Names By Layer, 2802
Assign Pit Precedence, 2828
Assign Property Names, 2690
Assign Spoil Names, 2974
Assign Strata Correlation, 2411
Assign Template Point Centerline, 1496, 1519, 1531
Assign Template Point Profile, 1495, 1519
Assign Timing Grids, 2830, 2835, 2897
Attach Image to Entity, 1891
Attribute Definitions, 691, 2444
Attribute Layers, 516
Attribute Layout ID, 261, 263, 303, 516
Attribute Validation Report, 2430
Audit Image Links, 1893
Audit Links, 1855
Auto-Connect Pillars, 2670, 2671
Auto Annotate, 119, 535, 662, 700–702, 704, 706
    708, 710, 712, 739, 3074
AutoCAD Map LPN links, 1865, 1866
Auto Create Points, 949, 950
Auto Lines, 995
Auto Longitudinal Profile, 2342
Auto Map, 928, 938
Automatic Point Numbers, 261
AutoMine Connections, 2644, 2646, 2668, 2792
Auto Place by Text, 2731, 2772
Auto Point Number, 995
Auto Point Plot, 995
Auto Points at Interval, 2129, 2160
AutoRun Residuals, 2521
AutoRun Strata Quantities, 2472
Auto Tablet On, 228, 1154
Average Profiles, 1376
Average Section Files, 1456
Average Slope, 1670, 1825
Azimuth-Distance with Leader, 721
Backfill, 2057, 2059, 3324, 3334
Backsight, 229, 349, 350, 366, 368, 380, 382, 385–
    387, 395, 398, 400, 403, 572, 573, 577, 581
    600, 789, 821, 832, 834, 982, 1008, 1019
    1024, 2092, 2093, 2125, 3111
Bare Earth, 2216, 2217
Barscale, 18, 233
Basic Mining Menus, 2352
Basic Mining Module, 2351, 2727
Basic Projections, 2649, 2786
Bearing-Bearing Intersect, 584, 585, 589, 869
Bearing-Distance Intersect, 588, 870
Bearing-Distance with Leader, 720
Bearing & 3D Distance, 210
Bearing Annotation, 698
Bearing Area Cutoff, 640
Bearing with Leader, 719
Bed Composite Report, 2426
Bed Names, 2366, 2373
Beltline, 2662
Benchmark, 842, 843, 395, 400, 592, 820, 2133, 2648
Bench Marks, 2648, 2765
Bench Mining, 2890
Bench Pond, 19, 1214, 1216, 1218, 3154, 3157
Berm Grades, 1471
Best Fit, 895, 896, 980, 995
Best Fit Centerline, 614
Best Fit Circle, 613, 614
Best Fit Curve, 168
Best Fit Line by Average, 615, 616
Best Fit Line by Least Squares, 616
Best Fit Point, 612
Best Fit Profile, 1375
Best Fit Transformation, 958
Blast Pattern Layout, 2966, 2969
Blast Point Report, 2969
Blending Weighted Average, 2517, 2518
Blips, 117, 209, 210
Block Diagram, 2400, 2530
Block Explode, 96
Block Model 3D Viewer, 2550, 2629, 2633
Block Model Inspector, 2548
Block Model Menu, 2535
Block Model Statistics, 2550
Bold Curve Leader, 202
Border, 904–906, 1125, 1946, 2222, 2765, 2767
Boundaries, 1040, 1108, 1233, 1975, 2335, 2567, 2570, 2572
Boundary, 19, 203, 546, 568, 625, 666, 670, 796, 938
1107, 1122, 1630, 1911, 1925, 2017, 2042
2297, 2299, 2307, 2311, 2317, 2319, 2320
2322, 2323, 2325, 2328, 2334, 2346, 2348
2501, 2504, 2505, 2680, 2690, 2691, 2694
2507, 2800, 2802, 2805, 2808, 2808, 2813
2815, 2816, 2819, 2821, 2825, 2832, 2839
2840, 2853, 2954, 2977
Boundary Enclosure, 2674, 2677
Boundary Menu, 2801
Boundary Polyline, 203, 546, 1109, 1910, 1920, 1922
1978, 2048, 2601, 2620, 2694, 2806, 2808
2974, 3092, 3094, 3289, 3304, 3321, 3330
3354, 3355, 3366
Break, 19, 56, 100, 101, 112, 123, 124, 595, 686, 971
1063, 1225, 1327, 1461, 2500, 2621, 2636
2661, 2662, 2902, 3070, 3090, 3092, 3094
3148
Break 3D Polyline by Surface, 1088
Break at Intersection, 100, 3092
Break by Crossing Polyline, 99
Breakline, 223, 1113, 1125, 1127, 1128, 2252, 2284
Breaklines, 913, 1097, 1106, 1109, 1113, 1125, 1390
1936, 2197, 2216, 2957
Break Polyline at Specified Distances, 100
Break Polyline by Property, 2697
Bubble Cul-de-Sac, 893
Buffer Offset, 133, 134, 620
Building Dimensions, 723, 725, 3075
Building Face Surface, 2136
Building Offset Extensions, 598, 599
Building Pad, 663, 664
C-factor, 3234
Calculate C-Factor, 1639, 1640
Calculate End Area, 1462, 1463
Calculate Fault Shift, 2477
Calculate GeoFluv Volume, 2334
Calculate Haul Factors, 1446
Calculate Horizontal, 882
Calculate Intersection Point, 1381
Calculate Offsets, 170, 1278, 1372
Calculate Pond/Pit Volume, 1197, 1948, 1949, 1956
1957, 3172
Calculate Removels Volumes, 1932
Calculate Removals Volumes, 1932
Calculate Residuals, 2518, 2521, 2610, 2611
Calculate Section Volumes, 1459, 1463, 3183, 3187
Calculate Spoil Volumes, 2984
Calculate Stage-Storage, 1707
Calculate Stockpile Volume, 1195, 1948, 3153, 3172
3179
Calculate Total Volumes, 1951, 1956, 2041, 3291, 3306, 3312, 3313, 3318, 3360, 3372
Calculate Variogram, 2494
Calculate Volumes Inside Perimeter, 1956, 3312, 3318
Calculate Volumes, 2844, 2847, 2849, 2856, 2859, 2860, 2880, 3002, 3003
Callout Leader, 201, 202
Calls, 921, 923, 938, 941, 974, 991
Call Table, 925, 926
Camera Tab, 2220, 2223
CAP files, 1709
Carlson Directory Structure, 2
Carlson Field Icon Menu, 2137
Carlson File Types, 25
Carlson GIS and Esri, 1828
Carlson On-line Manual with Movies, 322
Carlson Points, 105, 292, 318
Carlson Registration, 11
Carlson Settings Explorer, 244
Case Studies, 2584, 2770, 2996
Case Study #1: Techniques of Geological Compositing, 2584
Case Study #2: Outcrop and Subcrop Modeling, 2595
Case Study #3: Techniques Of Gridding, 2603
Case Study #4: Limestone Block Modeling, 2613
Case Study #5: Block Modeling by Quality Attributes, 2630
Case Study #5: Surface Timing With Benches, 2996

Index
Index
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Channel Settings</td>
<td>2317</td>
</tr>
<tr>
<td>Current Information</td>
<td>767</td>
</tr>
<tr>
<td>Curve,</td>
<td>927-929, 932, 933, 938, 968, 969, 977, 980, 981, 983, 995, 1028-1031, 1042, 1139, 1251-1254, 1257, 1259, 1260, 1265, 1267, 1269, 1275, 1278, 1280, 1285, 1301, 1304, 1323, 1329, 1330, 1356, 1359, 1375, 1382, 1388, 1482, 1484, 1489, 1490, 1513, 1517, 1573, 1574, 1584, 1625, 1627, 1636, 1637, 1646, 1648, 1650, 1664, 1670, 1706, 1707, 1711-1713, 1716, 1719, 1721, 1722, 1761, 1811, 1823, 2001, 3022, 3023, 3028, 3189, 3193, 3194, 3224, 3234, 3264</td>
</tr>
<tr>
<td>Curve - Arrow</td>
<td>199, 200</td>
</tr>
<tr>
<td>Curve Between Tangents</td>
<td>883</td>
</tr>
<tr>
<td>Curve Calc</td>
<td>170, 882</td>
</tr>
<tr>
<td>Curve Info</td>
<td>213, 226</td>
</tr>
<tr>
<td>Curve Number Library</td>
<td>1774, 1775</td>
</tr>
<tr>
<td>Custom Drillhole Report</td>
<td>2422</td>
</tr>
<tr>
<td>Custom Label Formatter</td>
<td>749</td>
</tr>
<tr>
<td>Custom Label Formatter AD</td>
<td>710</td>
</tr>
<tr>
<td>Cut/Fill Centroids</td>
<td>1191, 1975, 2334</td>
</tr>
<tr>
<td>Cut/Fill Color Map</td>
<td>1186, 1187, 1950, 2068, 2075, 3290, 3305, 3360, 3371</td>
</tr>
<tr>
<td>Cut/Fill Contours</td>
<td>1189, 1950, 2067</td>
</tr>
<tr>
<td>Cut/Fill Grid Map</td>
<td>1187, 1188</td>
</tr>
<tr>
<td>Cut/Fill Labels</td>
<td>1184, 2064, 2066, 2067, 3312, 3318</td>
</tr>
<tr>
<td>Cut/Fill Map Legend</td>
<td>1977, 3360, 3371</td>
</tr>
<tr>
<td>Cut/Fill Slope Lines</td>
<td>1192, 1194</td>
</tr>
<tr>
<td>Cut/Fill Width Analysis</td>
<td>1442</td>
</tr>
<tr>
<td>Cut and Place (Spoil Removal)</td>
<td>2924</td>
</tr>
<tr>
<td>Cut Image</td>
<td>2029</td>
</tr>
<tr>
<td>Cut Only</td>
<td>2928</td>
</tr>
<tr>
<td>Cut Only (Coal Removal)</td>
<td>2928, 3012, 3014, 3016</td>
</tr>
<tr>
<td>Cut Sheet</td>
<td>558, 560, 561, 563, 564, 600, 1443</td>
</tr>
<tr>
<td>Cutsheet</td>
<td>2086</td>
</tr>
<tr>
<td>Cutsheet Spreadsheet Editor</td>
<td>2078</td>
</tr>
<tr>
<td>Database File Utilities</td>
<td>1868</td>
</tr>
<tr>
<td>Data Capture</td>
<td>1841, 1843, 1845, 1847</td>
</tr>
<tr>
<td>Data Capture Add Point Data to Linework</td>
<td>1845</td>
</tr>
<tr>
<td>Data Capture Block Attributes</td>
<td>1843</td>
</tr>
<tr>
<td>Data Capture Enclosed Text</td>
<td>1841</td>
</tr>
<tr>
<td>Data Capture Text By Sample</td>
<td>1839</td>
</tr>
<tr>
<td>Data Collectors</td>
<td>325, 326, 353, 357, 381, 385, 3277</td>
</tr>
<tr>
<td>Data Collector Transfer</td>
<td>472, 792, 798, 821, 845</td>
</tr>
<tr>
<td>Data Depot</td>
<td>238, 244</td>
</tr>
<tr>
<td>Data Entry</td>
<td>2304</td>
</tr>
<tr>
<td>Data File Types and Storage</td>
<td>3383</td>
</tr>
<tr>
<td>Data for Current Channel</td>
<td>2319</td>
</tr>
<tr>
<td>Data for GeoFluv Work Area</td>
<td>2323</td>
</tr>
<tr>
<td>Data for Main Channel</td>
<td>2313</td>
</tr>
<tr>
<td>Data Link</td>
<td>183, 186</td>
</tr>
<tr>
<td>Data Links</td>
<td>2711, 2855</td>
</tr>
<tr>
<td>Data Objects</td>
<td>2224, 2229, 2242</td>
</tr>
<tr>
<td>Data Tab</td>
<td>2223</td>
</tr>
<tr>
<td>Deed Correlation</td>
<td>539, 540</td>
</tr>
<tr>
<td>Deed Description</td>
<td>26</td>
</tr>
<tr>
<td>Deed Linework ID</td>
<td>539</td>
</tr>
<tr>
<td>Deed Reader</td>
<td>536, 539, 556, 3388</td>
</tr>
<tr>
<td>Default Pit Attributes</td>
<td>2827, 2829, 2831, 2837</td>
</tr>
<tr>
<td>Define Area Layers</td>
<td>1878, 1879</td>
</tr>
<tr>
<td>Define Attributes</td>
<td>2356, 2357, 2367, 2369, 2416, 2443, 2444</td>
</tr>
<tr>
<td>Define Block Database Links</td>
<td>1870, 1871</td>
</tr>
<tr>
<td>Define Dragline Equipment</td>
<td>2909, 2914, 2923, 3007</td>
</tr>
<tr>
<td>Define Drillhole</td>
<td>2375, 2376, 2381, 2382, 2384, 2385, 2410</td>
</tr>
<tr>
<td>Define Equations</td>
<td>2356, 2368</td>
</tr>
<tr>
<td>Define Equipment</td>
<td>2356, 2372, 2730, 2747, 2778</td>
</tr>
<tr>
<td>Define Fern Codes</td>
<td>2369, 2403</td>
</tr>
<tr>
<td>Define Fill/Cut Design</td>
<td>2951</td>
</tr>
<tr>
<td>Define Geologic Order</td>
<td>2367</td>
</tr>
<tr>
<td>Define Grade Parameters</td>
<td>2540</td>
</tr>
<tr>
<td>Define Horizon Codes</td>
<td>2370</td>
</tr>
<tr>
<td>Define Layer Target/Material/Subgrade</td>
<td>1905, 1909</td>
</tr>
<tr>
<td>Define Lookup Database</td>
<td>2366</td>
</tr>
<tr>
<td>Define Lot Attributes</td>
<td>691</td>
</tr>
<tr>
<td>Define Lot Edge Grade Rules</td>
<td>1062, 1068</td>
</tr>
<tr>
<td>Define Materials</td>
<td>1909, 1959</td>
</tr>
<tr>
<td>Define Note File Prompts</td>
<td>1867, 1868, 2089</td>
</tr>
<tr>
<td>Define Panel Attributes</td>
<td>2719, 2728, 2730</td>
</tr>
<tr>
<td>Define Parameters</td>
<td>2431, 2436, 2438, 2440, 2449</td>
</tr>
<tr>
<td>Define Pipe Groups</td>
<td>2055</td>
</tr>
<tr>
<td>Define Pit Attributes</td>
<td>2838, 2892</td>
</tr>
<tr>
<td>Define PreCalculated Grids</td>
<td>2473</td>
</tr>
<tr>
<td>Define Road Design Parameters</td>
<td>1512, 1520, 1568</td>
</tr>
<tr>
<td>Define Strata</td>
<td>233, 234, 2355, 2357, 2360, 2365</td>
</tr>
<tr>
<td>Define Strata Grids AutoRun</td>
<td>2455</td>
</tr>
</tbody>
</table>

**Index**

3426
Define Strata Isopach AutoRun, 2464
Define Surface Mine Auto Run, 2503
Define Template Database, 1830, 1832–1835, 2089
Define Watershed Layers, 1621, 1626, 3244
Delete, 908, 944–946, 952, 965, 971, 1001, 1210, 1217, 1284, 1285, 1302, 1388, 1402, 1417, 1483, 1495, 1497, 1653, 1704, 1712, 1756, 1757, 1772–1775, 1832, 1836, 1840, 1842, 1844, 1869, 1880, 2120, 2194, 2196, 2206, 2230, 2232, 2253, 2259, 2262, 2264, 2269, 2285, 2316, 2385, 2484, 2807, 2950, 2955, 3122, 3145, 3150, 3409, 3411
Delete Attribute, 2417
Delete Labels, 973
Delete Layer, 249
Delete Points, 273, 281
Delete Strata, 2416
Delete Table Elements, 747
Delta Angle, 167, 698, 705, 707, 728, 729, 750, 1203, 2247
Densify Polyline Vertices, 117
Depth Contours, 1182, 2042
Depth Sounder, 2159
Description for Points, 273, 281
Description of Software, 2295
Descriptions, 994, 1009, 1018, 1029, 1033, 1037, 1038, 1289, 1392, 1399, 1425, 1427, 1434, 1929, 2012, 2085, 2384, 3021, 3035, 3069, 3083
Description Tables, 961, 962, 966, 967, 976
Design Bench Pit, 20, 2498, 2499, 2725, 2889, 2941, 2944, 2948, 2962, 2996, 2997, 3000
Design Bench Pit, 1210, 1212, 1216, 1218, 1665, 1688, 3157, 3158, 3282, 3285, 3296, 3297, 3299, 3357, 3358, 3368, 3369
Design Bench Pond, 2948
Design Centerline, 1250, 1251, 1253, 1263, 1517
Design Contours, 2066
Design Control, 3398
Design Dragline Pit, 2939
Design Drawing, 2065, 3282, 3285, 3296, 3297, 3299, 3357, 3358, 3368, 3369
Design Fill Surface, 2948
Design GeoFluv Regrade, 2306, 2307, 2331, 2333, 2335, 2337
Design Lot, 680
Design Pad Template, 27, 1199, 1202, 1204, 1210, 1354, 1464, 3139, 3154, 3157, 3160, 3162, 3163, 3165, 3168
Design Profile, 1518
Design Regrade, 1444, 1446
Design Road Profile, 1296, 1302, 1354, 1518
Design Section Staging, 1449
Design Sewer/Pipe Profile, 1305, 1338, 1736
Design Spillway, 1690
Design Spoil Pile, 2946
Design Surface, 2066, 2067, 2074, 2300, 2302, 2321
Detach Image From Entities, 1892
Detention Pond Sizing, 1686, 1688, 3229
Detention Pond Sizing - Linear Storage Estimate Method, 1687
Difficulty factor, 2710, 2728, 2742, 2827, 2828, 2854
Digitize 2D Polyline, 2013
Digitize 3D Polyline, 2015
Digitize Areas, 627, 2017
Digitize Contour Polyline, 2018
Digitize Contours (Polyline), 1153
Digitize Design, 2011
Digitize End Areas, 1405, 2021
Digitize Existing, 2011
Digitize Menu, 2006
Digitize Other, 2011
Digitize Perimeter, 2017
Digitize Point, 2012
Digitize Rectangle, 2016, 2017
Digitizer Settings, 2009, 2011
Digitizer Setup, 2008, 3338, 3344
Digitize Sections, 2019
Digitize Sections Plan, 1402
Digitize Sections XSec, 1403
Digitize Spot Elevation, 2012
Direct-Reverse Settings, 382, 383
Disconnect Mineplans, 2741
Display-Edit File, 215
Display Centerline Stations, 878
Display Directions, 2825, 2827, 2982, 2984
Display Last Report, 215
Display Menu, 2063
Display Options, 2069, 3290, 3305, 3360, 3371
Display Order by Layer, 148
Display Precision, 430
Distance-Bearing with Leader, 721
Distance-Distance Intersect, 587, 870
Distance Between Two Entities, 1280
Distance with Leader, 720
Disturbed Area, 1619
Ditch, 1383, 1384, 1470, 1471, 1479, 1492, 1760, 1764, 3165, 3167
Detachment, 1495
Index

227, 228, 254, 255, 266, 289, 518, 545, 550
568, 571, 584, 607, 608, 618, 619, 690, 696
699, 700, 731, 738, 742, 750, 758, 761, 762
Draw Drawing Template, 21, 497
Draw Legend, 730–732
Draw Lot Setback, 648
Draw Lots from File, 625
Draw Mapcheck, 909, 910
Draw Mass Diagram, 1437, 1462
Draw Menu, 151
Draw North Arrow, 732
Draw Outcrops, 2444
Draw Outline, 2665
Draw Overexcavate Cut Color Map, 1923
Draw Overexcavate Surface 3D Faces, 1923
Draw Perimeter, 2666, 3170, 3171
Draw Pillars, 2666, 2680, 2792
Draw Pipe 3D Polyline, 1377, 1398, 1421, 1451
Draw Pit/Channel Sample Text, 2393
Draw Plan View Sheets, 1348
Draw Polyline Blips, 117
Draw Polyline File, 87
Draw Polyline Start/End, 118
Draw Profile, 19, 220, 1315, 1316, 1321, 1338
1341, 1342, 1346, 1350, 1352, 1375, 1377
1437, 1441, 1451, 1482, 1672, 1693, 1801
1805, 2049, 2052
Draw Profile Grid, 1342
Draw Raster Image, 2023, 2024
Draw Reame File, 2973
Draw Removal Breakline, 1929
Draw Removal Contours, 1931
Draw Removal Field to Finish, 1929
Draw Removal Surface, 1931
Draw Roadside Ditch, 1384
Draw SB-Slope File, 2973
Draw Section Alignment, 1389
Draw Section File, 1419, 1420, 1433, 1458, 1502
1516, 1517, 1520, 3019, 3186, 3215, 3216
3218, 3377, 3380
Draw SectionTemplate DWG, 1408
Draw Sewer Network-3DFaces, 1807
Draw Sewer Network Centerlines, 1804
Draw Sewer Network Data Table, 1802
Draw Sewer Network Plan View, 1802
Draw Sewer Network Profile, 1805, 1806
Draw Single Manhole, 1374
Draw Spot Elevations, 1071
Draw Stage-Discharge Graph, 1714
Draw Stage-Storage Curve, 1709, 3234
Draw Standard Item, 182, 183, 187
Draw Strata Cut Color Map, 2042, 2043, 3312, 3318
Draw Strata Cut Depth Contours, 2042
Draw Strata Surface, 2043, 2052
Draw Strike-Dip Symbol, 2485
Draw Subgrade Hatch Legend, 1915
Draw Subsidence Profile, 2763
Draw Super Elevation Diagram, 1486, 1521
Draw Surface As Grid, 1977
Draw Surface Boundary, 1224
Draw Surface Intersection, 1224
Draw Text On Arc, 750
Draw text on Tangent, 752, 753
Draw Top Surface 3D Faces, 1927
Draw Traverse-Sideshot Lines, 384
Draw Trench Network - Plan, 2051
Draw Trench Network - Profile, 2052
Draw Trench Network Centerline, 2051
Draw Triangular Mesh, 1221, 1223, 1233, 1239
Draw Typical Template, 1475, 1564, 1672, 2057
Draw Voroni Diagram, 2553
Draw Watermark, 1685
Drillhole Core Images, 2389
Drillhole Data Sheet, 2386, 2424
Drillhole Import, 2032, 2398, 2614, 2615
Drillhole Inspector, 2409
Drillhole Menu, 2040, 2355
Drillhole Reports, 2040
Drillholes to Points, 2380
Drillhole Strata Settings, 2030
Drillholes without key strata, 2425
Drillhole Text Formatter, 20, 2398
Duplicate Drillhole Report, 2425
Duplicate Points, 57, 273, 282
Duplicate Strata, 2034, 2373
Duplicate Drillhole Report, 2425
Duplicate Points, 57, 273, 282
Duplicate Strata, 2034, 2373
DWG Tab, 2329
DXFOUT Mine Plan to SDPS, 2759
Dynamic Annotation, 227
Dynamic Annotation Note, 712
Earth Curvature, 370, 387, 389, 2087
Earthworks File, 1463
Eagle Point, 319, 320, 501, 503
Eagle Point Coding, 501
Edit, 907–909, 944–946, 948, 959, 961, 963, 966
968, 970, 971, 981, 1000, 1006, 1008, 1018
1020, 1028, 1030, 1033, 1035, 1040, 1041
1048, 1051, 1065, 1084, 1087, 1089, 1127
1131, 1143, 1157, 1167, 1168, 1209, 1210
1253, 1257, 1262, 1263, 1274, 1284, 1285
1289, 1298, 1302, 1312, 1313, 1324
1329, 1346, 1364, 1368, 1370, 1388, 1390
1407, 1412, 1413, 1415, 1416, 1437, 1438
Index

3429
Edit-Assign Grade Rules, 1067
Edit-Assign Wall Polyline Profiles, 1051
Edit-Process Level Data, 395
Edit-Process Raw Data File, 325, 348, 405, 535, 552, 554
Edit/Create Sanitary/Utility Structure, 1785, 1786
Edit/Create Structure With Inverts, 1813
Edit 3D Grid, 1170
Edit Area Table Properties, 631
Edit Bench Pond, 1216, 1217
Edit Centerline On-Screen, 1262
Edit Coal Sections, 2679
Edit Contours, 1142, 2004, 3131
Edit Coordinates (CGEditor), 948, 949
Edit Drillhole, 2036, 2357, 2362, 2365, 2379, 2383
Edit Fault Line, 2476
Edit File, 90
Edit Layout Element, 1666
Edit Longitudinal Profile, 2340, 2343
Edit Map Check File, 859
Edit Menu, 90, 356, 400
Edit Mining Symbols Library, 2643
Edit Multiple Pt Attributes, 302
Edit Pad Template, 1208, 1210
Edit Panel, 2732, 2748
Edit Panel Attributes, 2721, 2722, 2730
Edit Pit, 2835, 2837, 2839, 2862, 2873, 2892, 3001
Edit Pit/Channel Sample, 2395
Edit Point, 261, 268, 288
Edit Point Attributes, 261, 300, 301
Edit Points, 291, 523, 540
Edit Polyline Section, 122
Edit Polyline Vertex, 127, 122, 2003
Edit Process End Area File, 1463
Edit Process SDMS File, 401
Edit Raw File, 791, 792
Edit Selected Layer, 1909
Edit Sewer Structure, 1776, 1811, 3257
Edit Spoil Source, 2987
Edit Spoil Volumes, 2986
Edit Symbol Library, 247
Edit Table, 736, 747
Edit Table Properties, 740
Edit Table Values, 744
Edit Text on Arc or Tangent, 753
Edit Trench Network Structure, 2047, 3323, 3333
Edit World File, 1885
Elevate 2D Polylines, 645
Elevate Lot Edges by Grade Rules, 1063
Elevate Menu, 1987
Elevate Pads by Grade Rules, 1065
Elevate Text, 1076
Elevation Between Points, 1077
Elevation Difference, 571, 578, 1179, 1323, 1326
Elevations, 994, 1057, 1058, 1074, 1076, 1077, 1080
Elevations, 1429, 1435, 2088, 2089, 2140, 2141, 2252
Elevations, 2391, 2426, 2451, 2785
Elevations, 1090, 1111, 1156, 1196, 1198, 1263, 1269
Elevations, 1288, 1290, 1319, 1322, 1329, 1343, 1351
Elevations, 1352, 1394, 1399, 1425, 1427, 1428, 1688
Elevations, 2035, 2036, 2045, 2059, 2085, 2298, 2314
Elevations, 2334, 2404, 2449, 2499, 2523, 2537, 2567–
Elevations, 2569, 2628, 2632, 2765, 2942, 2948, 3151
Elevations, 3162, 3181, 3182, 3209, 3241, 3321, 3330
Elevations Zone Analysis, 1233, 1235
Elevation Zones, 1222

Index 3430
Empty Print File, 787
End Areas, 26, 1426, 1558
Enter-Assign Point, [575], 576
Enter and Assign, 266, 3083
Enter Deed Description, 534, 543, 3021, 3084
Enter Profile On-Screen, 1296
Enter Right of Way, 1281, 1283
Enter Roadside Ditch, 1383, 1384
Entities to Polylines, 84, 116, 1262
Entity Insertion Point Rotate, 105
Entry Width, 2686, 2728, 2733
Equipment Calendar, 2356, 2705, 2715, 2730, 2848
Equipment Menu, 2157
Equipment Setup, 2092, 2097, 2099, 2108, 2111, 2114, 2118, 2137, 2140, 2151, 2160, 2162, 2164, 2166, 2170, 2172, 2173, 2175, 2178
Erase, 934, 1088, 1094, 1112, 1202, 1266, 1354, 1352, 1583, 1584, 1837, 1839, 1847, 1849, 1851, 1910, 1913, 1916, 1918, 1919, 1936, 2026, 2041, 2058, 2583, 2924, 3028, 3042, 3047, 3071, 3074, 3093, 3094, 3150, 3155, 3158
Erase by Closed Polyline, 92
Erase by Layer, 91
Erase Links, 1853, 1854
Erase Outside, 93
Erase Overexcavate Cut Color Map, 1924
Erase Overexcavate Surface 3D Faces, 1923
Erase Point Attributes, 307
Erase Points, 292
Erase Strata Cut Color Map, 2043
Erase Strata Cut Depth Contours, 2042
Erase Strata Surface, 2043
Erase Sub-Areas Hatch, 668
Erase Subgrade Hatches, 1915, 3286, 3300, 3359
Erase Subgrade Labels, 1916
Erase Surface from DWG, 91, 97, 98, 3044, 3071
Ersi ArcGIS Services - Retrieve Map, 1855
Escapeways, 2648, 2665
Esri ArcGIS Services - Define Feature Class by Layer, 1860
Esri ArcGIS Services - Identify Map Features, 1859
EW File, 1462, 1463
Example Projects, 472
Existing Contours, 2064, 3341, 3347
Existing Drawing, 2063, 3308, 3314
Existing File, 29, 68
Existing Section, 1449, 1519, 1522, 1525, 1581, 1585
Existing Surface, 2064, 2065, 2964, 3182, 3213
Existing Surface 3D Viewer, 1964
Existing Surface Vertical Offset, 1951
Exit Drawing Standards, 197
Explode Carlson Points, 313
Export Carlson Sewer Network, 1820
Export Coordinates to ASCII, 771
Export Drawing to AutoCAD 14, 84
Export Drillholes, 2376, 2378, 2380
Export DWG File with Esri MSC, 1863
Export ESRI Projection File, 1864
Export GIS Data to SurvCE, 1865, 3276
Export Google Earth File, 83, 86, 1248, 1887
Export LandXML File, 77, 1405
Export Lot File to MDB Database, 693
Export Lot File To Old SurvCADD, 693
Export Pit/Channel Samples, 2393
Export Polyline File, 1979
Export RoadXML File, 81
Export SHP File, 1863
Export Text, 276
Export Text/ASCII File, 270, 273, 276, 290
Export Topcon TIN File, 1249
Export To Points, 1820
Export To Profiles, 1821
Export Trench Network Data, 2049
Extend, 96, 99, 152, 154, 157, 159, 424, 1364, 1391, 1414, 1440, 1454, 1461, 1463, 1574, 1805, 1956, 1957, 2476, 2821, 2955, 3039, 3042, 3046, 3070, 3071, 3085, 3132, 3171, 3183, 3189
Extend Arc, 96
Extend Bench, 2946
Extend by Distance, 97, 98, 3044, 3071
Extended Entity Data, 88, 2826, 2835, 2984
Extend Sections to Offset Limits, 1454
Extend To Elevation, 1087
Extend to Intersection, 96
Extract Breaklines, 2213, 2285
Extract Centroid Data, 2697
Extract Contours, 2210
Extract Profile, 2212, 2229
Extract Project Archive, 225
Extract Sections, 2211
Extrapolate, 236, 1085, 1135, 1157, 1159, 1161, 1167
1171, 1177, 1181, 1186, 1292, 1391, 1635, 2099, 2421, 2475, 2609
Extrapolate Grid, [222, 223, 2609
Extrapolation, 1157, 1171, 1186, 1187, 2466, 2499
2504, 2817
Fence Diagram, 20, 26, 2401, 2474, 2475, 2489
2490, 2522, 2525, 2528, 2530, 2539, 2588
2598, 2602, 2603, 2607, 2617, 2629, 2635
2636, 2923, 2924, 2928, 3007
Fence diagram, 2490, 2598
Fence Polylines, 2530
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input-Edit Profile File</td>
<td>1312</td>
</tr>
<tr>
<td>Input-Edit Road Profile</td>
<td>1297, 1302, 1312</td>
</tr>
<tr>
<td>Input-Edit Rock Section File</td>
<td>1406</td>
</tr>
<tr>
<td>Input-Edit ROW Offsets</td>
<td>668</td>
</tr>
<tr>
<td>Input-Edit Section Alignment</td>
<td>1387, 1390, 1501</td>
</tr>
<tr>
<td>Input-Edit Section File</td>
<td>1412, 1420, 1519</td>
</tr>
<tr>
<td>Input-Edit Stage-Discharge</td>
<td>1712, 1714</td>
</tr>
<tr>
<td>Input-Edit Stage-Storage</td>
<td>1703, 1704, 1707</td>
</tr>
<tr>
<td>Input-Edit Strike-Dip Symbols</td>
<td>2484</td>
</tr>
<tr>
<td>Input-Edit Super Elevation</td>
<td>1482, 1509, 1519, 1565</td>
</tr>
<tr>
<td>Input-Edit Template Series</td>
<td>1491, 1492, 1518, 1533</td>
</tr>
<tr>
<td>Input-Edit Trench Template</td>
<td>1370</td>
</tr>
<tr>
<td>Input-Edit Trench Template. Trench From Polyline</td>
<td>2043, 3321, 3330</td>
</tr>
<tr>
<td>InRoads</td>
<td>511, 1406</td>
</tr>
<tr>
<td>Insert Block with GIS Data</td>
<td>1872</td>
</tr>
<tr>
<td>Insert Mining Symbols</td>
<td>2641</td>
</tr>
<tr>
<td>Insert Multi-Point Symbols</td>
<td>179</td>
</tr>
<tr>
<td>Insert Symbols</td>
<td>176, 179, 3047, 3048</td>
</tr>
<tr>
<td>Insert with Join/Align</td>
<td>1882</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>3, 10</td>
</tr>
<tr>
<td>Instruction Manual and Program Conventions</td>
<td>41</td>
</tr>
<tr>
<td>Instrument Data Project Items</td>
<td>2229</td>
</tr>
<tr>
<td>Interior Point</td>
<td>135, 622, 1637</td>
</tr>
<tr>
<td>Intermediate Contours</td>
<td>972</td>
</tr>
<tr>
<td>Interpolate Entity</td>
<td>1077</td>
</tr>
<tr>
<td>Interpolate Points</td>
<td>594, 896, 1076</td>
</tr>
<tr>
<td>Intersections</td>
<td>583, 643, 645, 871, 894, 906, 995</td>
</tr>
<tr>
<td>Intersection/Cul-de-sacs</td>
<td>891, 893</td>
</tr>
<tr>
<td>Intersects</td>
<td>568, 569, 874, 875, 1288</td>
</tr>
<tr>
<td>Interval Along Entity</td>
<td>595, 2969</td>
</tr>
<tr>
<td>Interval Between Points</td>
<td>595</td>
</tr>
<tr>
<td>Introduction</td>
<td>1, 10</td>
</tr>
<tr>
<td>Introduction and Overview</td>
<td>2291</td>
</tr>
<tr>
<td>Invalid Strata Report</td>
<td>2428</td>
</tr>
<tr>
<td>Inverse</td>
<td>570, 572, 574, 577, 597, 624, 867, 1522</td>
</tr>
<tr>
<td>Inverse with Area</td>
<td>623, 624</td>
</tr>
<tr>
<td>Isolate Layer</td>
<td>144, 264, 1148</td>
</tr>
<tr>
<td>Isolate Layers</td>
<td>1882, 3041, 3042</td>
</tr>
<tr>
<td>Item Properties</td>
<td>2274</td>
</tr>
<tr>
<td>Item Standards Manager</td>
<td>186, 248</td>
</tr>
<tr>
<td>Join 3D Polyline</td>
<td>131, 1084</td>
</tr>
<tr>
<td>Join Nearest</td>
<td>116, 133, 1084, 1118, 1262, 1354, 2215</td>
</tr>
<tr>
<td>Join Text Entities</td>
<td>114</td>
</tr>
<tr>
<td>K Value</td>
<td>1382</td>
</tr>
<tr>
<td>Label/Draw Right of Way</td>
<td>1283</td>
</tr>
<tr>
<td>Label Angle</td>
<td>736, 741, 759, 1073</td>
</tr>
<tr>
<td>Label Arc</td>
<td>728, 747, 749, 3055, 1074</td>
</tr>
<tr>
<td>Label Block Model</td>
<td>2544</td>
</tr>
<tr>
<td>Label Contours</td>
<td>972, 1074, 1117, 1940, 2072, 2466</td>
</tr>
<tr>
<td>Label Coordinates</td>
<td>18</td>
</tr>
<tr>
<td>Label Coordinates/Elevation</td>
<td>759, 761</td>
</tr>
<tr>
<td>Label Curb Flow Elevations</td>
<td>762</td>
</tr>
<tr>
<td>Label Drillhole</td>
<td>2037, 2387</td>
</tr>
<tr>
<td>Label Elevations Along Polyline</td>
<td>1090, 1092, 1094</td>
</tr>
<tr>
<td>Label GIS Polyline</td>
<td>1849</td>
</tr>
<tr>
<td>Label GIS Polyline: Closed Polyline Data</td>
<td>1849</td>
</tr>
<tr>
<td>Label GIS Polyline: Closed Polyline Image</td>
<td>1847</td>
</tr>
<tr>
<td>Label GIS Polyline: Open Polyline Data</td>
<td>1850</td>
</tr>
<tr>
<td>Label Last Area</td>
<td>627</td>
</tr>
<tr>
<td>Label LatLon</td>
<td>761</td>
</tr>
<tr>
<td>Label Object Data Areas</td>
<td>1876</td>
</tr>
<tr>
<td>Label Offset Distances</td>
<td>764</td>
</tr>
<tr>
<td>Label Pad Elevation</td>
<td>1089</td>
</tr>
<tr>
<td>Label Pit/Site Names</td>
<td>2802</td>
</tr>
<tr>
<td>Label Polyline High/Low Points</td>
<td>1094</td>
</tr>
<tr>
<td>Label Polyline Segment</td>
<td>1095</td>
</tr>
<tr>
<td>Label Profile Differentials</td>
<td>1379</td>
</tr>
<tr>
<td>Label Profile On Centerline</td>
<td>1365, 1369, 1525</td>
</tr>
<tr>
<td>Label Projection Distances</td>
<td>2665</td>
</tr>
<tr>
<td>Label Property Lines</td>
<td>2695</td>
</tr>
<tr>
<td>Label Sewer Laterals</td>
<td>1380</td>
</tr>
<tr>
<td>Label Spoil Names</td>
<td>2977</td>
</tr>
<tr>
<td>Label Station-Offset</td>
<td>1272</td>
</tr>
<tr>
<td>Label Sub-Areas</td>
<td>668</td>
</tr>
<tr>
<td>Label Subgrade Areas</td>
<td>1916</td>
</tr>
<tr>
<td>Label Zeros</td>
<td>265, 499</td>
</tr>
<tr>
<td>Land Development Desktop</td>
<td>3, 57</td>
</tr>
<tr>
<td>Landuse</td>
<td>1619</td>
</tr>
<tr>
<td>LandXML Data Transfer</td>
<td>3401</td>
</tr>
<tr>
<td>Language Localization</td>
<td>42</td>
</tr>
<tr>
<td>Laser Atlanta</td>
<td>2161</td>
</tr>
<tr>
<td>Lateral Design Overview</td>
<td>1746</td>
</tr>
<tr>
<td>Latitude/Longitude</td>
<td>571</td>
</tr>
<tr>
<td>Latitude and Longitude</td>
<td>2113</td>
</tr>
</tbody>
</table>
Layer and Style Defaults, 24
Layer Control, 992–994, 2663, 3028, 3038, 3046, 3070, 3076, 3089
Layer ID, 208, 3070, 3285, 3299, 3358, 3369
Layer Inspector, 208
Layer Library, 248, 249, 251
Layer Properties Manager, 2258
Layer Report, 208
Layout Manager, 72, 73, 171
LDD, 57, 314, 315, 402, 986, 3406
LDT Migration Guide, 3382
Leaders, 934, 1095, 2825, 2983
Leader With Text, 200
Least squares, 403, 404, 424, 2032, 2453, 3111
Legal Description Writer, 545, 546, 686
Legend Definition, 730, 732, 3057
Leica, 318, 326, 339–343, 353, 355, 400, 423, 447, 832, 1385, 1386, 2094, 2100, 2102, 2137, 2162–2164, 2239
Leica Disto, 2162
Leica GPS System 500, 2162
Leica TC Series, 2163
Lesson 10: Basic Road Design with Volumes, 3188
Lesson 11: Road Rehabilitation, 3208
Lesson 12: Hydrology and Watershed Analysis, 3218
Lesson 13: Stormwater Network Design, 3241
Lesson 14: Data Extraction for HydroCAD, 3264
Lesson 15: ESRI to Office to Field and Back, 3274
Lesson 16: Takeoff Tutorial: CAD File Takeoff From Start To Finish, 3278
Lesson 17: Takeoff Tutorial: Drillhole and Strata, 3308
Lesson 18: Takeoff Tutorial: Trench Network Quantities, 3319
Lesson 19: Takeoff Tutorial: Digitizing, 3338
Lesson 1: Entering a Deed, 3021, 3084
Lesson 20: Takeoff Tutorial: PDF Section Import, 3373
Lesson 2: Making a Plat, 3029
Lesson 3: Field to Finish for Faster Drafting, 3064
Lesson 4: Intersections and Subdivisions, 3082
Lesson 5: SurvNET, 3106
Lesson 6: Contouring, DTM and Design, 3127
Lesson 7: Contouring, Break Lines and Stockpiles, 3140
Lesson 8: A Dozen Tools for Surface Design, 3154
Lesson 9: Calculate Volumes By Five Methods, 3169
License Agreement, 48
License Models, 9
Lift Station Design, 1737
Limitations of, 2291, 2292
Limit Polylines, 234, 2481, 2489, 2491, 2602, 2607
Line and Curve Labeling, 3393
Linear, 1467, 1687, 1688, 1907, 2032, 2453, 2454, 2702, 2713, 2714, 2794, 2795, 2846, 2857, 3211, 3309, 3315
Line by Angle-Distance, 597
Line On/Off, 576, 580
Lines, 996, 1029, 1048, 1063, 1109, 1119, 1121, 1131, 1133, 1155, 1221, 1266, 1267, 1272, 1289, 1299, 1318, 1323, 1330, 1339, 1390–1392, 1399, 1420, 1487, 1574, 1631, 1689, 1795, 1799, 1879, 1935, 1939, 1942, 2033, 2048, 2072, 2201, 2451, 2490, 2496, 2525, 2571, 2661, 2764, 2766, 2768, 2769, 2972, 3028, 3061, 3074, 3076, 3147, 3154, 3287, 3302, 3393, 3302
Lines and Polylines, 916, 920
Lines by Codes, 918
Lines by Description, 917
Lines by Point Number, 916
Line Table, 704, 739, 741, 742
Line Type Scaler, 217
Line Up Text, 113
Linework Intersection Points, 583
Link Points with Coordinate File, 261
Links Manager, 280, 1851
Links with Other Software, 2303
LISCAD, 341–343
LisCad, 318
List, 953, 957, 965, 976, 1165, 1168, 1246, 1406, 1412, 1414, 1417, 1495, 1497, 1790, 1831, 1929, 1933, 1979, 2033, 2048, 2092, 2135, 2136, 2150, 2200, 2288, 2359, 2625, 2626, 2706, 2717, 2741, 2850, 2861, 3085, 3151, 3156, 3158, 3162, 3277, 3282, 3286, 3287, 3297, 3301, 3352, 3363, 3410, 3416
List Points, 217, 261, 266, 268, 273, 281, 499
Load Image Set, 1901
Loading Carlson Menus, 14
Load Saved Report, 215
Load Tablet Calibration, 2009
Local Elevation Label, 1151
Locate by Azimuth, 581
Locate by Bearing, 581, 582, 588, 2641
Locate by Delta, 582
Locate by Line Bearing, 580
Locate by Turned Angle, 581
Locate on Real Z Axis, 261, 265, 585, 2085
Locate Point, 18, 24, 90, 261, 266, 308, 348, 499, 582, 2790
Locate Reach, 1669, 1668
Locate Structures, 1667, 3240
Locate Structures TR20, 1665
Locate Template Points, 1613
Lock Layers, 150

Index

3435
Move Calls, 923
Move Elevation Labels, 1092
Move Label Along Contour, 1151
Move Label with Leader, 717
Move Point Attributes, 310
Move Point Attributes Single, 305
Move Point Attributes with Leader, 305, 310
Move Points, 300
Move Section Leader Labels, 1458
Move Sewer Label, 1807, 1808, 3260
Move Sewer Profile Labels, 1347
Move Text, 106
Move Text with Leader, 106
Multi-Draw, 911
Multi-Point Symbols, 179, 182
Multileader with Text, 173
Multiple Offsets, 95
Multiple Outlet Design, 1701, 1703
MXS File, 1387, 1388, 1392, 1394, 1397, 1398

N-E Line, 2649
NAD83, 900, 977
NADCON, 276
Name Limit Polylines, 2488
Name Pit Polylines, 2801
National Geodetic Survey, 447, 2083
Natural Regrade File, 2306
Natural Regrade Global Settings, 2307, 2309, 2313, 2320, 2323, 2328
Natural Regrade Menu, 2306
Natural Regrade Module, 2290
Navcom Configuration Guide, 2165
Navcom GPS Setup, 2167
Nearest Found, 497, 508, 1394
Network Menu, 1739
Network Processing Reports, 473

New/Startup Wizard, 22
New Area Table, 631
New File, 31
Nikon, 326, 343, 344, 354, 394, 844, 845, 2170, 2171
Nikon Total Stations, 2170
Nodes, 264, 2671, 3272
Non-Surface Entities, 1105, 1109
North Arrow, 18, 1321, 1350, 2767, 3055
North Rotation, 3403
Note File, 559, 1406, 1868, 1869, 2086, 2089
Notes Menu, 2641
Numeric, 228, 569, 690, 767, 795, 826, 938, 1034, 2677, 2678, 2794, 2795, 3031, 3406
Numeric Pad COGO, 592

Object Data, 234, 1876, 1878
Object Linking, 89, 227
Obtaining Technical Support, 15
Occupy Point, 572, 577
ODBC, 35, 2691
Off, 996, 1012, 1013, 1018, 1023, 1029, 1032, 1033, 1037, 1038, 1050, 1072, 1073, 1075, 1090, 1091, 1112, 1114, 1118, 1124, 1135, 1150, 1151, 1209, 1214, 1217, 1268, 1270, 1275, 1277, 1280, 1289, 1292, 1299, 1310, 1311, 1315, 1319, 1321, 1323, 1329, 1330, 1333, 1343, 1350, 1356, 1357, 1360, 1374, 1379, 1388, 1391, 1393, 1394, 1399, 1402, 1403, 1407, 1411, 1413, 1415, 1421, 1424, 1426–1428, 1432, 1434, 1437, 1443, 1444, 1450
1453, 1455, 1457, 1466, 1468, 1470, 1472–1474, 1479, 1486, 1495, 1522, 1524, 1526, 1548, 1549, 1554, 1556, 1574, 1583, 1613, 1615, 1641, 1740, 1742, 1769, 1780, 1781, 1789, 1818, 1863, 1917, 1939, 1940, 1946, 1974
2305, 2398, 2401, 2407, 2460, 2464, 2465, 2501, 2521, 2526, 2527, 2575, 2577, 2644–2646, 2646, 2650, 2652, 2653, 2659, 2663, 2672, 2786, 2789, 2790, 2876, 2914, 2916, 2932

Index
Index

2943–2945, 3042, 3046, 3049, 3051, 3052, 3077, 3078, 3084, 3086, 3087, 3098, 3160, 3163, 3165, 3211–3213, 3279–3281, 3285, 3286, 3289, 3290, 3293, 3295, 3299, 3301, 3304, 3305, 3320, 3324, 3329, 3330, 3334, 3359, 3370

Offset 3D Polyline, 131, 1082, 1088, 1354, 1534, 3079, 3137, 3154, 3156, 3158, 3163, 3165

Offset & Elevation Report/Plot, 1436

Offset Cutoff, 58, 87

Offset Dimensions, 723–725

Offset Point Entry, 171, 1276

Offsets & Intersections, 643, 644

Offsets from ASCII File, 2647

Offset Stakeout, 2148

Offset Strata Polylines, 2487

Offset to Area, 94

Offset To Layer, 94

OmniStar Otto, 2171

One Grid Surface Volumes, 1176

One Surface Volumes, 2512

One Triangulation Surface Volumes, 1171

One Way Control, 602

Open, 769, 770, 772, 783, 791, 792, 849, 851, 854, 858, 859, 861, 866, 890, 911, 959, 971, 998, 1000, 1002, 1005, 1007, 1011, 1012, 1028, 1032, 1036, 1041, 1116, 1138, 1150, 1205, 1246, 1287, 1292, 1313, 1314, 1316, 1413

Peak Flow - Graphical Method, 1645

Peak Flow - Rational Method (General), 1648

Peak Flow - Rational Method (KYDOT), 1650

Peak Flow - Rational Method(Riverside S. California), 1649

Peak Flow - Tabular Hydrograph Method, 1646

Perimeter Polylines Properties, 1978

Pick & Place Panel, 2729, 2775

Pick Current Layer, 994

Pick Intersection Points, 582

Pick Layers to Freeze, 992

Pick Layers to Thaw, 992

Pick Layers to turn Off, 993

Pick Layers to turn On, 993

Pillar Cut, 2672, 2674, 2797, 2798

Pinch Out, 2613

Pipe Culvert Design, 1729, 1730, 1734

Pipe Depth Summary, 1363

Pipe Elevation Label, 1809

Pipe Manning’s N Library, 1772

Pipe Polylines, 1398

Pipe Routing Hydrograph, 1656

Pipes, 3401

Pipe Size, 27, 1315, 1358, 1371, 1741, 1743, 1779, 1783, 1789, 1791, 1816, 1819, 2044, 2045, 2048, 3259, 3322, 3324, 3332, 3333

Pipe Size Library, 1770, 1772, 1783, 1789, 3259

Pipe Width, 1295, 1337, 1398, 1451

Pit/Channel Samples - Import from CRD File, 2392

Pit/Channel Samples - Import from Text File, 2391

Pit Areas, 2501, 2505, 2891, 3000

Open Dos Drawing, 784

Opening Closing and Saving, 768

Optimized Pit Design, 2554, 2630, 2637, 2638

Ore Body, 2584

Orifice Design, 1697, 1699, 1701

Other Drawing, 2068, 2070, 3282, 3285, 3287, 3289, 3326, 3329, 3310, 3304, 3308, 3314, 3357, 3358, 3368, 3369

Outcrops, 2595, 2600

Output Coordinate File, 1520, 1524

Output Tab, 2322

Output To Reame, 2971

Output to SB-Slope, 2973

Overburden, 2881, 2892

Overlay Section File, 1455

Overview, 1046, 1618, 3405, 3411, 3417, 3419

Overview Draw Standard Items, 182

Ownership, 26, 2686, 2960

Pad Polyline By Interior Text, 1059, 1996

Panel & Room Label Block, 2665

Panel Attributes, 2709, 2721, 2722, 2776, 2777, 2852

Panels Report, 2744

Parking, 647, 1645, 1648

Patch Management, 46

Pattern Point Survey, 2137

Pavement Manning’s N Library, 1774

Pavement Manning’s N Library, 1773, 1774

PC, PT, Radius Length, 161

PC, PT, Radius Point, 160

PC, PT, Tangent, 161

PC, Radius, Arc Length, 162

PC, Radius, Chord, 161

PCMCIA card, 343

PC Point, 162

PDMODE, 315

PDSIZE, 227, 260

Pipe Culvert Design, 1729, 1730, 1734

Pipe Depth Summary, 1363

Pipe Elevation Label, 1809

Pipe Manning’s N Library, 1772

Pipe Polylines, 1398

Pipe Routing Hydrograph, 1656

Pipes, 3401

Pipe Size, 27, 1315, 1358, 1371, 1741, 1743, 1779, 1783, 1789, 1791, 1816, 1819, 2044, 2045, 2048, 3259, 3322, 3324, 3332, 3333

Pipe Size Library, 1770, 1772, 1783, 1789, 3259

Pipe Width, 1295, 1337, 1398, 1451

Pit/Channel Samples - Import from CRD File, 2392

Pit/Channel Samples - Import from Text File, 2391

Pit Areas, 2501, 2505, 2891, 3000

Pit by Interior Point, 2806
Point Channel Samples, 2391
Pit Directions, 2997
Pit Inspector, 2839
Pit Label Formatter, 2802
Pit Layout, 2601
Pit Layout by Advance, 2813
Pit Layout by Rate, 2816
Pit Layout by Width, 2815
Pit Layout by Rate, 2816
Pit Matrix Layout, 2601
Pit Matrix Layout, 2808
Pit Plines from Mineplan, 2806
Pit Points Report, 2834
Pit Polylines, 2525
Pit Plines from Mineplan, 2806
Place Calls, 921
Place Camera Symbol/Image, 1891
Place Coal Sections, 2679
Place Drillhole, 1522
Place Drillholes, 2381
Place Google Earth Image, 1886
Place Image By Circle, 1902
Place Image By Point, 1901
Place Image by World File, 1884
Place Labels, 972
Place Labels, 2975
Place Panel, 2698
Place Pit/Channel Sample, 2394
Plain View Label Settings, 1747
Point Clouds Getting Started, 2281
Point Clouds Module, 2180
Point Clouds Project Manager, 2181
PointCloud Viewer, 2187
Point Code, 994
Point Defaults, 153
Point Description, 90
Point Editor, 2268
Point Entity, 303
Point Group Manager, 286
Point Groups, 967
Point ID, 207
Point Label, 936
Point Layer, 515
Point Manager, 941
Point Notes, 268
Point Number Report, 273
Point Object Snap, 230
Point Offset Report/Plot, 1411
Point on Arc, 593
Point Placement on Profile, 1372
Point Placement on Section, 1409
Point Protect, 75
Point Range, 27
Points, 996
Points and Lines, 997
Points and Point Groups, 3390
Points by Slope Ratio, 1078
Points Menu, 260
Points on Arc, 884
Points on Line, 880
Point Store, 2122
Points and Lines, 997
Points and Point Groups, 3390
Points by Slope Ratio, 1078
Points Menu, 260
Points on Arc, 884
Points on Line, 880
Point Store, 2122
Polygon Export to ADE, 1880
Index
3439
Polygon Inspector, 1879

Polygon Processor, 27 1134 1874 1879 1880

Polygon Query, 1880

Polyline by Nearest Found, 206

Polyline by Slope Ratio, 205 1393 1520

Polyline Editor, 2259 2261

Polyline File, 86 88 1980

Polyline Info, 214 3162 3164

Polyline Report, 567

Polylines by Point, 918

Polyline Slope, 1387

Polyline Slope Report, 1359

Polyline to Centerline File, 1261 1264 1531 1535

Polyline to Deed File, 568

Polyline to Lot File, 681

Polyline to Right of Way, 1282 1283

Polyline to RW5 File, 568

Polyline to Special Line, 755 758 3046

Polyline to Tree Line, 756

Pond Design, 1215, 1705

Pond Exfiltration Design, 1699–1701

Pond Sizing, 1645, 1646, 1648

Post-Subsidence Contours, 2761

Pre-Calculated Grids, 2420, 2497, 2504, 2516, 2517, 2523, 2528, 2603, 2606, 2609

Pre-calculated grids, 27 2516

Pre-disturbed Surface, 2314

Predefined Boundaries, 1107 1108

Prediction Point Output, 2760

Prepare HEC-RAS Input File, 1674, 1676, 1679, 1681

Prepare HEC2 Input File, 1683

Prepare Story Stake, 2142

Prepare Value Block Model, 2551, 2555

Prepare Variogram Data, 2497

Preview, 2322 2323 2373 2574 2616 2843 2902 2950 2966 3033 3065 3082

Print View Print File, 787

Index

PRO. 21 25 27 48 52 69 75 220 225 561 563

818 820 1287 1289 1297 1302 1305

1306 1312 1313 1329 1342 1343 1351

1352 1355 1357 1359 1360 1362 1369

1384 1386 1391 1396 1409 1439 1495

1496 1501 1518 1554 1557 1561 1563

1567 1573 1575 1581 1585 1589 1593

1675 1736 1819 1875 1879 1880 1975

2148 2166 2181 2213 2244 2529 2649

2651 2660 2768 2769 2787 2972 3210

3385

Problems Addressed by Natural Regrade with GeoFluv, 2291

Process Deed File, 18 543 544 568

Process Design Sections, 1611

Process Dragline Sequence, 2921 2925 2929 2935

2936 2938 3014 3018

Processed Data Project Items, 2242

Process Fill/Cut Design, 2958

Process Layerized Text, 1874

Process Menu, 434

Process Only Strata with Beds, 233, 234

Process Road Design, 1516 1518 1524 1525 1528

1530 1531 1533 1537 1540 1543 1611

3205 3206 3215 3217 3396 3413

Production By Block Model, 2559

Production Timing, 2863

Profile, 2320 2325 2339 2522 2523 2529 2629

2763 2764 2931 2941 2956 3154 3162–3164

3166 3190 3192 3213 3215 3217 3260

3261 3312 3318 3321 3327 3328 3330

3337 3384 3395 3397 3399 3401

Profile Conversions, 1384 1386

Profile from 3D Points, 1291

Profile from 3D Polyline, 1290 1535

Profile from Grid or Triangulation Surface, 1289

Profile from Layers, 1294

Profile from Pipe Polylines, 1295 1377

Profile from Points on Centerline, 1293

Profile from Polyline on Profile Grid, 1293

Profile from Section File, 1292

Profile from Surface Entities, 1288 1294

Profile ID, 1369

Profile Menu, 1285

Profile Offset Text, 1378 1379

Profile Report, 1357 1359 1736

Profiles, 3395 3401

Profile to 3D Polyline, 1354

Profile To Points, 1355

Programming Interfaces, 3404

Project Explorer, 60 64 68 70 71 223 225

Projecctions, 2649 2655 2661 2768 2786

Projecctions & Ventilation, 2660

Project Manager, 2181 2182 2185 2187 2218

2220 2225 2270 2778 2869 2872 2873

3002

Project Settings, 2189 2191 2200 2235 2255 2265

Project Setup, 246 2275

Project Tab, 2182 2189 2193 2203 2212 2217

2238 2249 2252 2258 2259 2268 2274

Project Tree, 2182 2243

Project Checklist, 1905

Properties Converter, 1881

Property Boundaries, 2501 2504 2505 2749

Property Data Report, 2691

Property Menu, 2689

Property Names By Text, 2694

Quantities by Average Method, 2674 2679 2680

3440
Index

2682, 2796, 2798
Quantities by Centerlines, 2678, 2686
Quantities by Grid Method, 2679, 2682, 2688, 2795
2797
Query, 937, 938, 980, 1835, 1836, 2388
Quick Contours, 1224
Quick Draw Surface, 1223
Quick Fence, 2529
Quick Geologic Column, 2387
Quick Keys, 16, 251, 252
Quick Profile, 1286, 1287, 1950, 1974
Quick Section, 1399, 1400
Quick Traverse, 788, 789, 980, 982, 983, 995

Radial Stake Out, 895
Radial Stakeout, 599, 600, 894
Radius Point, 155, 159, 165, 166, 213, 535, 567, 929
Railroad, 170, 729, 1356, 1388
Railroad Curve Table, 740
Rainfall Frequency and Amount, 1636
Rainfall Library, 1752, 1753, 1759, 3248, 3249, 3251
Range Diagram, 20, 2913, 3019
Raster Edit Options, 2025, 2026
Raster EndPoint Snap, 2028
Raster Menu, 2023
Raster Nearest Snap, 2028
Rational Method, 1621–1623, 1648–1650, 1654,
1656, 1752, 1753, 1759, 1765, 1769, 1775, 1783
Raw File On/Off, 575
Raw Traverse Data, 458
re-Associate Coord. file, 938, 939
Reactors, 89
Reame, 27, 2917, 2973
Reannotate, 712
Reassign Database File, 2379
Reassign Pit Attributes Grids Folder, 2830
Reassign Timing Grids Folder, 2831
Recalculate Extraction, 2737
Record Script, 89
Record Script, End Script, Run Script, 89
Recovery Percent, 2365, 2499, 2505
Rectangular Pond Design, 1688, 1706, 1709
Rectangular Weir Design, 1693, 3233
Reduce Contour Vertices, 1141
Reduce Direct-Reverse, 383
Reduce Map Check File, 859
Reduce Polyline Vertices, 58, 87, 116, 117, 228, 672
1980
Reduce Traverse, 845, 846, 859
Reduce Vertices, 1114, 1134, 1417, 1939, 2071, 2072
2210, 2460, 2465
Refresh Screen, 940, 941
Registration, 7, 8, 10, 12, 22, 2231, 2238, 2279
Regrade Backfill, 2964, 2965
Regrade Fill Slope, 1455
Removal Entities, 1930, 1931
Removal Manager, 1928
Removal Settings, 1927, 1931
Remove Area Table Rows, 654
Remove Bed Names After Last Key, 2418
Remove Duplicate Polylines, 123
Remove Empty Benches, 2829
Remove Groups, 89
Remove Panel, 2738
Remove Pin Point, 2743
Remove Pit Names, 2806
Remove Points from Screen, 915
Remove Polyline Arcs, 123, 2814, 2823, 2981
Remove Polyline Segment, 124, 3070, 3148
Remove Polyline Vertex, 124
Remove Property Data, 2690
Remove Reactors, 89, 713
Remove Sewer Structure, 1790
Remove Spaces From Text, 113
Remove Speckles, 2029, 2030
Remove Spoil Names, 2978
Remove Trench Network Structure, 2048
Remove XData, 88
Rename Attribute, 2417
Rename Bed, 2419
Rename Strata, 2416
Render, Shade, and Hide Commands, 123
Renumber Points, 281, 283, 312, 946, 953
Renumber Structure Names, 1812
repackaged, lii
Replace Text, 33, 114
Replot Descriptions, 763
Report, 2321, 2329, 2331, 2336, 2338, 2356, 2367
2379, 2390, 2391, 2422, 2424, 2431, 2442
2450, 2458, 2484, 2487, 2500, 2502, 2504
2506, 2515, 2519, 2521, 2525, 2551, 2556
2557, 2583, 2600, 2611, 2622, 2624, 2627
2637, 2680, 2681, 2685, 2687, 2689, 2699
2706, 2710, 2711, 2717, 2722, 2723, 2725
2726, 2730, 2748, 2752, 2776, 2796, 2797
2827, 2830, 2832, 2835, 2842, 2850, 2854
2861, 2864, 2866, 2868, 2878, 2881, 2884–
2886, 2888, 2890, 2895, 2897, 2905, 2907
2919, 2921, 2925, 2926, 2933, 2970, 2972
2985, 2998, 2995, 3006, 3028, 3034, 3101
3102, 3117, 3153, 3178, 3180, 3182, 3219
3220, 3232, 3239, 3259, 3263, 3285
3292, 3299, 3300, 3307, 3325, 3335, 3358
3361, 3369, 3370, 3373, 3377, 3380, 3396
Report 3D Polyline Station/Elevation, 1098
Report Areas By Layers, 1878
Report Fault Lines, 2478
Report Formatter Dialog, 33
Search Radius, 2452
Section Alignment, 1392, 1421, 1442, 1454, 3184, 3185, 3384
Section Conversion, 1406
Section Conversions, 1405
Section Defaults, 1392
Section File, 19, 560, 786, 787, 792, 970, 998, 999, 1032, 1389, 1392, 1393, 1395, 1397, 1398, 1402, 1407, 1408, 1420, 1421, 1430, 1435, 1442–1444, 1447, 1452–1454, 1457, 1462, 1470, 1517, 1519, 1520, 1526, 1569, 1581, 1585, 1685, 2020, 2148, 2152, 3185–3187, 3205, 3212
Section ID, 1459
Section Information, 2793
Section Menu, 1387
Section Name, 1420, 2648, 2769
Section Report, 1405, 1434, 1435, 1443, 1526
Sections (XSec), 1418
Sections from Coordinate File, 1395
Sections from Grid or Triangulation Surface, 1392
Sections from Layers, 1396
Sections from Points, 1394, 1518
Sections from Polylines, 1392, 3376, 3380
Sections from Profile, 1396
Sections from Surface Entities, 1390, 1396, 1397, 1417, 1518, 3196
Sections Points from Pipes, 1398
Sections Points from Right of Way, 1398
Sections Points from Surface Entities, 1397, 1398
Sections to 3D Polylines, 1447
Sections to Points, 1448, 1449
Section Subdivision, 601
Sections From Polyline On Section Grids, 2062
SEDCAD, 25, 231, 1618, 1621, 1670, 1671, 1673, 1674, 1709
SEDCAD Draw Flow Polylines, 1673
SEDCAD Label Structure Layout, 1673
SEDCAD Locate Structures, 1673
Select by Area, 137
Select by Block, 136
Select by Elevation, 114
Select by Filter, 137
Select by Length, 136
Select Drillskis By Filter, 2388
Selected Strata Quantities, 2470, 2472, 2584, 2585, 2588, 2591, 2593
Select GeoFluv Boundary, 2311
Select Main Channel, 2312, 2313
Select Similar, 138
Sequential Numbers, 197, 643, 2806, 2807, 3097
Serial Number Report, 322
Set/Reset X-Hairs, 256
Set Active Area Table, 631
Set Active Surfaces, 1950
Set Attribute By Grid File, 2862
Set Attribute by Grid File, 2718
Set Back Measure-Move, 648
Set Coordinate File, 260, 272, 348, 1250, 1883
Set CRD File for Lot Files, 693
Set Current, 966, 994, 1127, 1933, 2707, 2851, 2873
Set Current Position, 2743
Set Data Directory, 21, 23
Set Default, 966, 1017, 1019, 1039, 1422, 3216
Set Drawing Standards Data Source, 186
Set Layer, 145, 1238, 1551, 1552, 1556
Set Layer For Design, 1909
Set Layer For Existing, 1909
Set Layer For Other, 1910
Set Line Type, 901, 902
Set Lot File, 680
Set Point Elevations by 3D Polylines, 566
Set Point Elevations by Surface Model, 566
Set Polyline Origin, 119
Set Polyline To Elevation, 1048, 3287, 3301, 3302
Set Polyline to Elevation, 1988
Set Project/Data Folders, 220
Set Raster Image, 2023, 2026, 2027
Set Removal Boundary, 1931
Set Report Defaults, 2722
Set Rim Elevation to Match Surface, 1813
Set Sewer File, 1747, 1812, 1819, 1820, 3250
Set Strata by Parameters, 2438, 2439
Set Strata Key Status, 2414
Set Surface File, 1747, 3250
Set Table Position, 739
Settings, 2345, 2347, 2349, 2356, 2403, 2404, 2408, 2444, 2446, 2525, 2596, 2599, 2606, 2607, 2612, 2652, 2654, 2699, 2793, 2805, 2841, 2842, 2870, 2871, 2877, 2881, 2899, 2917, 2928, 2992, 3021, 3023, 3028, 3030, 3055, 3059, 3064, 3070, 3074, 3076, 3080, 3107, 3108, 3113, 3117, 3121, 3128, 3142, 3143, 3147, 3151, 3154, 3170, 3171, 3183, 3209, 3210, 3218, 3244, 3250, 3251, 3255, 3257, 3259, 3265, 3269, 3275, 3308, 3309, 3311, 3314, 3316, 3317, 3323, 3332, 3341, 3347, 3358
Settings File Manager, 246
Settings Menu, 216, 417, 1002, 1007, 1016, 1028, 1030, 1032, 1035, 1038, 1043
Setting Up a Project, 21
Set UCS to World, 146
Setup DOS Dwg, 785
Setup Property Link, 2691
Setup Tab, 2311
Sewer, 20, 27, 194, 223, 1305, 1307, 1312, 1314, 1335, 1347, 1348, 1380, 1381, 1421, 1735,
| Sewer Annotation | 1307 |
| Sewer Network | 1334, 1623, 1736, 1740, 1744, 1746, 1752, 1766, 1770, 1772, 1773, 1782–1784, 1787, 1791, 1792, 1795, 1796, 1798, 1803–1806, 1812–1815, 1817, 1819–1821, 1829, 2048, 3250, 3263 |
| Sewer Network Hydrographs | 1798 |
| Sewer Network Inspector | 1796, 1797 |
| Sewer Network Settings | 1739, 1776, 1778, 1784–1787, 1815, 1820 |
| Sewer Pipe Design: Individual | 1734, 1735 |
| Sewer Pipe Design: Read Profile | 1736 |
| Sewer Pipe Design: Sewer Network Segment | 1735, 1736 |
| Sewer Structure | 27, 196, 1746, 1747, 1751, 1790, 1804, 1806, 1807, 1819, 2045, 2047, 2057, 3324, 3334 |
| Sewer Structure Library | 1766, 1770, 1787, 1816, 1818 |
| Shade | 83, 84, 142, 509, 1233, 1922, 2749, 2876, 3243 |
| Show All Property Lines | 2696 |
| SHP File | 1863 |
| Shrink-Wrap Entities | 204, 3171 |
| Side Shots | 574, 577, 579, 853, 855 |
| Sight Distance | 376, 1299, 1304, 1314, 1382, 1513 |
| Sight Distance Design | 1382 |
| Simulation GPS | 2171 |
| Single Runoff Hydrograph | 1669–1671 |
| SiteNet Menu | 1249 |
| Size Lot by Frontage | 676 |
| Sketch | 206, 758, 1153, 1155, 2018, 2019, 3342, 3348 |
| Sketch Tree Line | 757 |
| Sliding Side Area | 637, 3094, 3095 |
| Slope At Points | 1237, 1238 |
| Slope Direction Analysis | 1243 |
| Slope Distance | 345, 386, 387, 395, 400, 491, 578, 591, 600, 834, 1360, 1381, 1382 |
| Slope Inspector | 2156 |
| Slope Ratio | 206, 1079, 1360, 1381, 1382, 1705, 1720, 1906 |
| Slope Report | 1235, 1359, 1360 |
| Slope Stake Report | 1451, 1453 |
| Slope Staking | 2152, 2153, 2155 |
| Slope Zone Analysis | 1239, 1454, 1935 |
| Slope Zone Section Analysis | 1454 |
| Smart Prompting | 1832, 1833 |
| SmarTrace | 206, 207 |
| SMI | 25, 326, 338, 339, 354, 393, 841, 844, 1250, 1406, 1524 |
| SMI Chain File | 1524 |
| Smooth Contours | 1134, 1139, 2460, 2465 |
| Smooth Grid | 1161 |
| Smoothing | 141, 1114, 1115, 1134, 1135, 1140, 1161, 1246, 1939, 1979, 2072, 2210, 2212, 2214, 2215, 2220, 2453, 2454, 2460, 2465 |
| Smooth Polylines | 126, 522, 2123 |
| Snap Contours to 3D Polylines | 2005 |
| Snap Linework To Points | 1883 |
| Snap Tolerance | 121, 614, 1059, 1375, 1883, 1996 |
| Softdesk | 236, 316, 318, 353, 1281, 1384, 1386, 1406 |
| Software Compatibility | 2304 |
| Sokkia | 2172, 2174 |
| Sokkia/SDR | 335, 336, 393, 1385 |
| Sokkia G | 326, 337, 2104, 2106 |
| Solar Observations | 608 |
| Solid Fill Polylines | 134 |
| Spad Number | 2644, 2646, 2790, 2791 |
| Special Fill Areas | 1919, 1920 |
| Special Leader | 201, 3054 |
| Special Line | 522, 753 |
| Special Line/Ent | 753 |
| Special Line/Entity | 758 |
| Spillway | 1689, 1691, 1711, 1714 |
| Spillway Design | 1665, 3233 |
| Spiral | 171, 549, 885, 887, 888, 1252, 1254, 1257, 1259, 1266, 1267, 1490 |
| Spiral Curve | 170 |
| Spiral Curve Design | 885 |
| Spiral Curve Stakeout | 887 |
| Spiral In | 1257 |
| Spirals | 1250 |
| Spline | 57, 920, 981, 1139 |
| Split Bed | 2419, 2586, 2587, 2589 |
| Split Bed By Parameters | 233, 2438, 2439 |
| Split Table | 745 |
| Split Text into Two Lines | 112 |
| Spoil by Interior Point | 2974 |
| Spoil Layout by Width | 2976 |
| Spoil Menu | 2974 |
| Spoil Pile | 2947 |
| Spoil Placement Timing | 2988, 2991 |
| Spoil Side | 2936, 3012, 3018 |
| Spot Drillholes | 2382 |
| Spot Elevations | 19 |
| Spot Elevations By Surface Model | 1073 |
| Spreadsheet Sewer Editor | 1798 |
| SQL | 18, 20, 228, 260, 273, 275, 404, 423, 470, 1829, 2358, 2376, 3406 |
| SRVPNO | 261, 312, 516, 1119 |
| Stack Label Arc | 728 |
SurvCOGO, 354, 394
Survey, 338, 3406
Survey Menu, 325, 342
Survey Module, 324, 348, 691
Surveyors Assistant, 326
Survey Text Defaults, 723–726
SurvNET, 401, 402, 404–407, 422, 454, 458, 468
471, 981, 998, 1002, 1011–1013, 1015, 1027, 3106–3111, 3113, 3117, 3121, 3124
SurvNET Editor, 472
SurvStar, 326, 331, 1867, 2119
Switch Bearing/Azimuth Quadrant, 715
Symbol Library, 18, 27, 176, 188, 260, 518, 1818, 2349, 2963
Symbol Plot Size, 200, 201, 217
Symbol Size, 191, 227, 320, 518, 731, 753, 904, 965, 986, 1121, 1781, 1788, 1921, 2031, 3047, 3048, 3077
System Requirements, 3
System Variable Editor, 257
Table Defaults, 735, 739
Table Header, 34, 690, 704, 706, 738, 739
Tables, 923, 925, 926, 1301, 1313, 1513, 1573, 1680, 1682, 1803, 1804, 1854, 2366
Tablet Calibrate, 1152, 1155, 1400, 1403, 1405, 2006
Tablet Calibration, 256, 1152, 1153, 1400–1402, 2007, 3340, 3345
Tablet On, 2006, 2010
Tablet Template, 12
Tabular Hydrograph Method, 1646
Tag Area Descriptions, 635
Tag Drillholes for Processing, 2440
Tag Hard Breakline Polylines, 1106
Tag Non-Surface Points, 1102, 1108
Tag Predefined Boundaries, 1107
Tag Slope Groups, 2962
Tag Strata Polylines, 2486
Tag Sub-Area, 666, 668
TakeOff Menu, 1905
Takeoff Module, 1904, 1979
Takeup Date, 2647, 2648
Tang, PC, Radius, Chord Length, 166
Tang, PC, Radius, Delta Angle, 166
Tangent, PC, Radius, Arc Length, 165
Tangent, PC, Radius, Tangent Length, 165
Tangent Between Curves, 889
Tangent Line from Circles, 597
Tangent Out Bearing, 534
Tape Baseline, 2077
Target Points, 2232, 2233, 2235, 2236, 2238, 2243, 2245, 2264, 2269
2273, 2274, 2278, 2279
TDS, 269, 326, 337, 338, 348, 434, 354, 355, 397, 503, 817, 821, 1281, 1406
TDS CR, 313
Technical Support, 8, 13, 15, 2011, 2167, 2170
Tech Support, 14
Template Database, 1830
Template Grade Table, 1480, 1481, 1491, 1506–1508, 1510, 1519, 1567, 1580, 3212, 3213, 3215, 3217
Template ID Library, 1515
Template Point Centerline, 19, 1262, 1282, 1300
Template Point Profile, 19, 561, 1300, 1466, 1477
1495, 1496, 1519, 1528, 1533, 1535, 1537
Template Transition, 1477, 1480, 1491, 1519, 1528–1531
Temporary Erase, 95
Terramodel, 1281, 1386, 1406
Textbox, 764
Text Enlarge/Reduce, 106, 110
Text Explode To Polylines, 86, 112
Text Export, 175
Text Height, 3402
Text Import, 174
Text Mask, 175
Text on Arc, 907
Text on Line, 173, 174
Text Plot Size, 217
Text Size, 106, 197, 361, 516, 620, 629, 631, 633

Index
Index
Index

3448